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Изучение
Welcome to Automation Anywhere Automation 360. Review these pages to get an introduction to our
latest RPA and Intelligent Automation platform.

Обзор

Automation 360 is the RPA industry's first purely web-based Intelligent Automation platform that is cloud-
native. Delivered in the Cloud or On-Premises, Automation 360 is designed for ease of use by all types of
users across technical skill levels. The platform enables businesses of all sizes to achieve unprecedented
scale with enterprise-class security, data privacy, and reduced time to value and costs of ownership. With
Automation 360, businesses can also leverage built-in artificial intelligence (AI) capabilities and easily
integrate third-party AI solutions, such as computer vision, natural language processing, and predictive
modeling—all with the simplicity of drag-and-drop AI into any automation workflow.
The Automation 360 platform also includes attended automation and plug-ins that enable business users
to automate tasks from within their business applications such as Microsoft Excel and Salesforce. This
capability makes automation of front-office processes easier, faster, and more cost-efficient.
Automation 360 is available globally and in 10 languages, including English, French, German, Japanese,
Korean, Italian, Portuguese, Russian, Spanish, Simplified Chinese, and Traditional Chinese.

Available products

The Automation 360 platform includes the following offerings:
• Automation 360 delivered in the cloud, hosted by Automation Anywhere with no client installation or

additional infrastructure required
• Automation 360, the full platform delivered On-Premises
• Automation 360 Free Trial, with 30 days to try the cloud-based offering with full tech support included

during the trial period
• Community Edition, a free web-based option for users to experience a wide-range of Enterprise A2019

бот creation capabilities

Documentation on previous releases

For documentation on previous versions of our products, see the PDFs available on these pages:
• Automation 360
• Enterprise 11.x
• Process Discovery
• Integrations
• IQ Bot 11x
• Mobile apps
• Human-Bot Collaboration 11.x

More resources

• Training on Automation 360: Get trained and certified on Automation 360 (A-People login required)
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• Industry first bot security program

Понятия, связанные с данным
Automation 360 — заметки о выпуске
Review the new capabilities, changes, fixes (resolved issues), security fixes, deprecated features, and
limitations in each release.
Сведения о Automation 360
Платформа Automation Anywhere Digital Workforce — это основа безопасной и масштабируемой
автоматизации сложных бизнес-операций. Automation 360 — это ведущая в отрасли платформа RPA
и цифровых рабочих ресурсов, которая сочетает в себе простой в использовании пользовательский
интерфейс с надежностью корпоративного класса и безопасностью для самоавтоматизации в
режиме реального времени.
Security architecture
Many of the largest financial organizations in the world rely on the Automation 360 secure digital workforce
platform to automate security-sensitive operations.
Информация, связанная с данной
Automation Anywhere Bot Store
Automation 360 platform
What is RPA?
What is a CoE?
Automation Anywhere University: RPA Training and Certification (A-People login required)

Сведения о Automation 360
Платформа Automation Anywhere Digital Workforce — это основа безопасной и масштабируемой
автоматизации сложных бизнес-операций. Automation 360 — это ведущая в отрасли платформа RPA
и цифровых рабочих ресурсов, которая сочетает в себе простой в использовании пользовательский
интерфейс с надежностью корпоративного класса и безопасностью для самоавтоматизации в
режиме реального времени.

Обзор

Automation 360 — это ведущая в отрасли платформа RPA и цифровых рабочих ресурсов,
которая сочетает в себе простой в использовании пользовательский интерфейс с надежностью
корпоративного класса и безопасностью для самоавтоматизации в режиме реального времени.
Интуитивно понятная браузерная платформа для бизнес-пользователей предназначена для быстрой
автоматизации задач, инструментов и процессов разработчиков. Automation 360 предоставляет
два варианта развертывания — On-Premises и Cloud. Это первая платформа, предоставляющая RPA
как услугу в качестве решения для автоматизации. Она позволяет автоматизировать приложения
в различных инфраструктурах и отраслях, таких как банковское дело, телекоммуникации и
автоматизация бизнес-процессов (BPO).
Automation 360 предоставляет следующие возможности.
• Интуитивно понятный интерфейс для создания бот и проектирования операций автоматизации

бизнес-процессов.
• Поддержка различных операционных систем, включая Windows, Linux и MacOS.
• Различные представления бот для упрощения совместной работы: представление блок-схемы для

бизнес-пользователей, представление списка для разработчиков и двойное представление для
совместной работы.

• Средство записи, которое работает на различных платформах, например Microsoft Windows, Citrix,
Web, и SAP.
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• Расширенные возможности переменных и поддержка JavaScript, Python и VBScript.
• Гибкая архитектура, позволяющая добавлять новые пакеты команд.

Компоненты Automation 360

Automation Anywhere Robotic Interface
(AARI)

AARI — это простой в использовании интерфейс,
который позволяет бизнес-пользователям
взаимодействовать с боты. Пользователи могут
запускать автоматизацию процессов, оставлять
отзывы о боты для возобновления процессов,
а также передавать другим пользователям
запросы для последующей обработки. AARI
позволяет предприятию раскрыть новые
возможности автоматизации при взаимодействии
людей и боты, которые ранее были недоступны
в рамках RPA.
Automation Anywhere Robotic Interface (AARI)

Рабочая область RPA Браузерная рабочая область, предоставляющая
инструменты и возможности для создания,
загрузки и развертывания боты с целью
автоматизации повторяющихся задач и
процессов. Она включает в себя следующее:
• Control Room
• Bot Runner
• Bot editor
• Bot Creator
• Credential Vault

Рабочая область RPA предоставляет следующие
возможности.
• Позволяет пользователям администрировать,

планировать и запускать боты
• Обеспечивает управление пользователями с

помощью привязки функций Active Directory
• Позволяет пользователям управлять

большим количеством Work Items благодаря
управлению рабочей нагрузкой

Обнаружение процессов An intelligent business solution that delivers a real-
time, data-driven map of your business to help you
uncover transformational process insights across
all applications, through each department, and
for every single task. Обнаружение процессов
follows the human instead of process logs by using
advanced computer vision, machine learning,
and artificial intelligence to capture every step in
every process across every system. It requires zero
integration, is universally compatible, and provides
the privacy and security of an on-premises solution.
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Privacy Enhanced Gateway Using Privacy Enhanced Gateway (PEG), enterprises
can confidently execute on their strategic business
initiatives by filtering their sensitive data in
a secure and scalable manner. PEG works by
redacting sensitive data that has been obtained
on customer's machines within their own network
before forwarding the data to the Обнаружение
процессов cloud for analysis. As all traffic from
the agents goes through PEG before leaving the
customer's perimeter, PEG removes personally
identifiable information (PII) and sensitive data.
Getting started with Privacy Enhanced Gateway

Discovery Bot Интеллектуальное бизнес-решение для
предприятий, которое предоставляет конечным
пользователям инструменты для определения
возможностей автоматизации с помощью
обнаружения процессов. Решение Discovery
Bot предназначено для автоматизации
операций путем документирования
процессов, выявления и приоритизации
возможностей бизнес-ориентированных
процессов на основе рентабельности, а также
автоматического создания боты. Discovery
Bot позволяет бизнес-работникам определять
возможности автоматизации, которые помогают
оптимизировать окупаемость инвестиций в RPA.
Process discovery by using Discovery Bot

IQ Bot Интеллектуальное решение для обработки
документов, которое может считывать
и обрабатывать различные сложные
документы и электронные письма.
IQ Bot сочетает RPA с различными
методами искусственного интеллекта для
интеллектуального сбора, классификации
и извлечения полуструктурированных и
неструктурированных данных, что позволяет
полностью автоматизировать бизнес-процессы,
ориентированные на работу с документами.
Install and update Automation 360 IQ Bot

Bot Insight Аналитическая платформа, которая
обеспечивает интерактивную и
интеллектуальную визуализацию
бизнес-процессов в режиме реального времени,
а также аналитику операций. Bot Insight
использует большой объем данных на уровне
содержимого и данных производительности,
создаваемых развернутыми боты, и преобразует
данные в ценные сведения с помощью
автоматически создаваемых и настраиваемых
информационных панелей.
Business analytics through Bot Insight
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Bot Store Торговая онлайн-площадка для готовых боты и
Digital Workers, которые работают на платформе
Automation 360. Прямой доступ к Bot Store из
Control Room для загрузки или отправки боты и
пакеты.
Bot Store

Частный Bot Store Безопасная внутренняя
торговая площадка
бот, которая
позволяет компаниям
размещать сведения
и документацию по
всем внутренним
разработанным
боты. Сотрудники
могут легко
выявлять внутренних
боты и команды
для повторного
использования в
дополнение к боты из
Automation Anywhere
Bot Store.

Частный Bot Store

На следующем изображении показаны компоненты Automation 360:
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Преимущества

Ускорение окупаемости • Мгновенное развертывание на основе
браузера, позволяющее быстро начать
разработку боты

• Интуитивно понятный интерфейс, который
позволяет пользователям с разным уровнем
навыков легко использовать продукт и
ускорить процесс обучения

• Упрощение взаимодействия между
бизнесом, отделами эксплуатации и
ИТ-подразделениями

Гибкость бизнеса • Регулярные обновления позволяют получать
доступ к актуальным данным с любого
устройства в любой точке
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• Непрерывность бизнеса благодаря высокой
доступности и аварийному восстановлению

• Масштабируемость

Самая низкая совокупная стоимость
владения (TCO)

• Дополнительные инвестиции в
инфраструктуру не требуются

• Единая платформа для фронт-офиса,
бэк-офиса и приложений сотрудников

• Снижение затрат на техническое
обслуживание

Модели развертывания
Automation 360 предоставляет следующие модели развертывания.

Cloud Automation 360 Cloud размещается в Automation
Anywhere, что дает возможность использовать
простую модель потребления платформы
Automation 360, созданную на базе облачной
архитектуры. С помощью службы Automation
360 Cloud платформа Automation 360, которая
включает Control Room и приложения Automation
360(Рабочая область RPA, IQ Bot, Bot Insight,
AARI и Discovery Bot), размещается в Automation
Anywhere. Доступ к ней пользователи могут
получить с помощью веб-браузера. Устройства
Bot Agent, где боты запускают и выполняют
автоматизацию, остаются в инфраструктуре
клиента и безопасно подключаются к службе
Automation 360 Cloud через протокол HTTPS.

С поддержкой облака В этой модели развертывания данные
размещаются On-Premises. Эта модель подходит
для клиентов, нуждающихся в соблюдении
строгих нормативных требований, которые
предполагают обязательный суверенитет
данных.

On-Premises with packages updates through
Cloud

With Automation Anywhere On-Premises with
packages updates through Cloud service, all
business, personal, and operational data is kept on
and deployed from the server on-premises on the
customer network.

На следующем изображении показаны модель развертывания для Automation 360:
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См. также Условия эксплуатации Cloud.

Встроенное руководство по продукту

Automation Anywhere uses a digital adoption platform to provide in-product user assistance (guides and
walkthroughs) and anonymously analyze product usage such as page views and feature clicks. This data is
used to inform user research and improve the overall experience of Automation Anywhere solutions.

Services performed • In-product guides and user notifications
• In-product educational spotlights
• Informational tips and other contextual user

assistance elements within the product to help
onboard users
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• Anonymized user analytics to understand usage
patterns of Automation Anywhere products

Data processed • Clicks on user interface elements within
Automation Anywhere products

• User ID in a form that does not disclose
the identity of the user (for example,
159:0a664495-7f3e-126a-817f-513aeedf003e)

• Web-browser type, web-browser version
• Server Control Room URL
• Language selected (English, Japanese, and so

on)
• User's first visit and last visit
• User's permissions settings
• List of features to which the user has access
• Product features that are used
• Automation Anywhere license type (Developer,

Attended User, and so on)
• Automation Anywhere product version number
• User provided ratings and feedback comments

on product features and functionality

Прим.:  The digital adoption platform does not
receive the user's IP address or бот information
such as which бот was run and what the бот does.

Types of data captured Automation Anywhere captures the following three
types of data when using the digital adoption
platform:
• Event data

Includes click and focus events providing usage
metrics. This enables us to understand the
adoption of features and usage patterns to
inform future improvements to the experience of
our products.
Пример.
• Clicking the Run Bot option
• Clicking the paths to open a бот in the Bot

editor
• Tabbing into a search input

Прим.:  The platform does not collect any user-
entered text.
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• Page load data
Includes data captured as users navigate to
various parts of the web application, such as
root paths of links and page titles

Прим.:  The platform does not collect any input
parameters sent through a link.

• Metadata
Includes metadata that is associated with
clicks and page loads when a user logs in to
Automation Anywhere products.
Metadata that is sent to the digital adoption
platform includes the following types of
information:
• Pseudonymized user ID
• Pseudonymized account ID
• Selected language
• Build number
• Browser version

Прим.:  The platform explicitly does not:
• Record the screen
• Perform any sort of screen-scraping
• Capture data entered in any input field

Blocking the platform Blocking the digital adoption platform will block
in-product user assistance and important system
messages such as the following:
• Productivity boosts through targeted user

tutorials
• Targeted important announcements and direct

communications
• Opportunity for in-app direct feedback, requests,

and support
• In-app integration to Automation Anywhere

documentation and support
• Ability to see user behavior so that we can

proactively make improvements to the product

Посмотрите следующее видео, чтобы узнать больше о RPA:
Информация, связанная с данной
Automation 360 platform
What is RPA?
What are RPA bots
RPA for Business Process Outsourcing (BPO)
Automation Anywhere University: RPA Training and Certification (A-People login required)
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Обзор Control Room
The Control Room manages, schedules, executes, and configures various capabilities of боты and Bot
Runner using a collection of specialized web services.

Компоненты

The Control Room is a centralized management point for all боты. A reverse proxy is responsible for
listening for remote connection requests and forwarding those requests to the correct specialized
service. The following figure shows the On-Premises Control Room components and general data center
interaction. Control Room components are shown in orange and data center components provided by
your organization are shown in blue. Components that are centrally hosted on cloud and managed by
Automation Anywhere such as license server are shown in white.

In the data center, Control Room is installed on a server and configured to interact with the other data
center components.
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The Control Room includes objects that performs the following:
• Control Room reverse proxy is managed through the following functions:

• Control Room services
• Control Room messaging
• Control Room caching

• Elasticsearch
• Licensing

The Control Room required data center components include:
• An SQL server with a Control Room database.
• A Server Message Block (SMB) file share

For Cloud Control Room architecture, see Cloud Control Room architecture image.

Centralized Automation Deployment

• Control Room acts as the single point of access and control for бот execution.
• Control Room provides бот upload and download features to facilitate seamless collaboration for end to

end business process automation by multiple users.
• All scheduling is managed by the Control Room. Ботs are deployed on the Bot Runner either ad hoc or

on pre-defined schedules. Once the schedules are created, Control Room automatically and intelligently
picks up the subsequent updates to боты, without any need to alter automation schedules.

Centralized Access Control

• Least Privilege and Access controls user access. They are implemented in the Control Room through
Role Based Access Control (RBAC).

• All Users and Roles are created and managed from the Control Room.

Collaboration Centralized Workforce Management

• Control Room dashboards provide a single view of the entire automation infrastructure.
• Control Room receives real time heartbeat and telemetry from automations with events, exceptions and

alerts.
• Unauthorized users cannot pause, resume or stop any of the ongoing automations on any Bot Runner.
• All historical automation data is logged in and available through Control Room Audit Logs.

Информация, связанная с данной
Control Room overview

Distributed architecture
Automation Anywhere platform is deployed using a distributed architecture.
Centralized management is accomplished via a web-based server, called the Control Room, to manage all
development and execution of the digital workforce. The Control Room is connected to Bot Creator and Bot
Runner. Bot Creator are development systems used for authoring and tailoring of automations. Bot Runner
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execute the automations; they are run-time systems installed on machines. Bot Runner can be deployed
on desktops, on virtual machines in data centers or cloud.

Distributed architecture with HA/DR support
The Automation 360 self-contained platform within the customer environment mitigates the risk of "cross-
contamination" from an unlikely event of a security breach from another network.
Automation Anywhere supports distributed architecture to deliver the optimal performance and security.
Following are the main distributable components of Control Room which can be clustered to achieve
High Availability (HA). In the image below, Automation Anywhere components are shown in orange and
components provided by your organization are shown in blue. Components that are centrally hosted on
cloud and managed by Automation Anywhere such as license server are shown in white.

Рисунок 1. Distributed Mode
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Distributed Cache

Control Room architecture uses distributed cache to update all other nodes as soon as any information is
updated in one of the nodes. This ensures fastest data synchronization across all the nodes and delivers
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seamless user experience. Automation 360 platform uses clustering mechanism to implement distributed
cache, to synchronize all data operations. For example, when the Credential Vault is opened from one
node, it is automatically opened for all other nodes too.
For information on HA/DR architecture for Automation 360 Cloud, see Automation 360 Cloud Security and
Data Privacy.
Понятия, связанные с данным
HA and DR deployment models
Automation 360 provides several deployment options to meet various levels of enterprise cost/price
performance and resiliency requirements. The options include installation on single nodes and on multiple
nodes. Multi-node deployments can be configured for highly available (HA) clusters and disaster recovery
(DR) sites.

Security architecture
Many of the largest financial organizations in the world rely on the Automation 360 secure digital workforce
platform to automate security-sensitive operations.
The platform's security architecture is founded on Least Privilege principles and a strict Separation of Duty
model with 41 technical controls implemented across seven NIST 800-53r4 Control Families. Controls are
applied across three components: the Control Room, Bot Creator (development systems), and Bot Runner
(бот execution run times) through the бот life cycle from creation through decommissioning. This security
architecture and the underlying controls are mapped to industry best practices as defined by NIST and can
be readily mapped to other frameworks, for example, CoBIT (SOX) and ISO 27002.

Access controls

Automation 360 limits and controls human and бот access to logical resources across components.
• Two independent control planes enforce least privilege. Only developers are enabled to read or write,

only authorized Control Room users to execute automations, (Control Room authorizes and executes)
subject to fine-grained Role Based Access Controls (RBAC) down to individual automations (бот), Bot
Runner and domains.

• Bot- level Separation of Duty is enforced. Each бот is obfuscated and executed by its corresponding
authorized Bot Runner.

• Бот execution is controlled via RBAC. Domain privileges are defined across groups of бот and Bot
Runner.

• Security at-rest and in-transit: All access credentials are secured at-rest via a central Credential Vault
with support for third-party credential stores. All communications are secured in-transit via SSL and
TLS.

Configuration management

Configuration management is controlled at both боты and Bot Runner levels.
• The Control Room authorizes, enforces, and logs changes to all Bot Creator and Bot Runner.
• Боты are controlled via a robust version control system, for rollback and full event logging.
• Бот change control on execution is enforced through encryption and authentication.
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Identification and authentication

Identification and authentication is controlled through Microsoft Windows authentication services.
• Bot Creator use Active Directory for authentication
• Bot Runner have two levels of authentication, one for autologin authentication of the runner and the

other for execution of боты.
• Credentials are secured at-rest and in-motion through the Credential Vault or integration with third-

party products.

Risk assessment

Risk assessment is undertaken on Static, Dynamic, and Network-based Vulnerability Assessments. Audit
and accountability are established through event capture, logging and auditing on all three components
with granular event capture at the бот level and nonrepudiation. Bot Insight embedded analytics provides
near-real-time Incident Response and integration with Security Event and Information Management
systems.
Информация, связанная с данной
RPA Security

Security architecture model
Automation Anywhere Cognitive security architecture is founded on Least Privilege principles and a strict
Separation of Duty model with 41 technical controls implemented across seven NIST Control families.
The NIST framework was selected as a foundation for best practices as a way to enumerate the controls
implemented throughout. Translations from NIST to other control frameworks are widely available,
resources are provided at the end of this topic.
The product security architecture is maintained by the Automation Anywhere Product Management team
and forms part of a formal policy model as an integral part of the Automation Anywhere Development
Roadmap. The following table lists the Control families and the corresponding features and security
impacts. Details on each Control family and how the security architecture is implemented in Automation
Anywhere products are in the corresponding topics.

Control Family Control Code Control Room Feature Security Impact

Access controls AC-3, 6, 7, 9, 10, 12 Central policy control Enforce access
restrictions for change
control and least
privileges on system
components:
• Fine grained access

to боты and Bot
Runner is controlled
via RBAC,

• Бот and Bot Runner
domains can be
assigned to roles via
RBAC

• RBAC roles are fully
audited
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Control Family Control Code Control Room Feature Security Impact

AC-2, 3, 5, 6 Role-based access
control (RBAC)

Enable user access,
restricts operational
privileges, enforces
least privilege principles

AC-17 Бот repository Бот versioning system
with access restrictions

AC-3, 7, 9, 10, 11 Бот and Bot Runner
encryption

Encryption and
obfuscation of sensitive
information at бот level
through credential
vault and integration
with key management
systems

Configuration (change)
management

CM-2, 5, 6, 7, 9 Centralized Bot Runner
control

Restrict functionality
based on roles,
domains, implement
deny-all and allow-by
exception

CM-10 Централизованное
лицензирование

Centralized
provisioning, tracking
and enforcement of Bot
Creator and Bot Runner
licensing

CM-2, 5, 6, 8 Бот operations room

CM-8 Inventory control Maintains centralized
inventory control of all
боты and runtimes

Bot Creator
configuration
management

SA-10 Bot Creator
management, бот
check-in, check-out

Control Room applies
software life cycle
management to боты
from development,
test, and production.
Бот versioning enables
change control of
automations.

Audit and accountability AU-1 through 15 Audit trail Automated event
logs captured on
three levels: Control
Room, Bot Runner,
and Bot Creator. Non-
repudiation is assured
through read-only logs,
all user identities are
bound to actions.
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Control Family Control Code Control Room Feature Security Impact

Identification and
authentication

IA-1 through 5 Active Directory
integration, Bot Runner
ID and Attestation

Implements Windows
platform security
including cryptographic
bidirectional
authentication, Bot
Runner identification
and attestation, and
password management
policies. Credential
vault with integration
with key management
systems, protects the
integrity of credentials.

Incident response IR-4, 6 Incident response Bot Insight embedded
analytics capabilities
can monitor events and
generate alerts to SIEM
systems for response.

Controlled maintenance MA-2 Automated
maintenance

Control Room
versioning system
provides an automated
mechanism to roll
out updates to боты,
historical information is
maintained.

(1) Resources: ISACA provides guides that map NIST SP800-53 to other security frameworks such as CoBIT (SOX),
SANS Top20.

Условия эксплуатации Cloud
Узнайте о моделях безопасного развертывания, расположении элементов данных и условиях
эксплуатации.

Обеспечение безопасности Cloud

Automation Anywhere Cloud разворачивается так, чтобы разрешить доступ только операционным
сотрудникам Automation Anywhere Cloud и специалистам отдела безопасности. Доступ к сети
и облачной плоскости управления предоставляется только операционным сотрудникам и
специалистам отдела безопасности AAI по VPN с помощью многофакторной аутентификации
(MFA). All AAI users must first authenticate using MFA tokens to retrieve short-term credentials to
access cloud resources. Соответствие учетных данных пользователей требованиям постоянно
отслеживается. Всем другим операционным пользователям, облачным ресурсам и приложениям
доступ к Control Room ограничен. Регулярно проводится сертификация доступа пользователей AAI
для предоставления доступа только сотрудникам, связанным с облачными операциями.
Облачная служба является многопользовательской, и для каждой клиентской среды Control Room
используется уникальный идентификатор участника для разделения данных между разными Control
Room. Специалисты Automation Anywhere не могут получить доступ к среде клиента, пока он не
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предоставит специальное разрешение. Обычно это происходит в рамках процедур и контроля
устранения неполадок службой поддержки.

Cloud С помощью Automation Anywhere Cloud все
персональные, операционные и бизнес-данные
хранятся в управляемом облаке Automation
Anywhere. Automation Anywhere является
контроллером облачных данных и обеспечивает
безопасность конфиденциальных данных
клиентов, опубликованных в соответствии
с требованиями Automation Anywhere в
области безопасности облака и соблюдения
конфиденциальности данных.
Privacy Policy for Automation Anywhere

С поддержкой облака Благодаря облачному решению Automation
Anywhere персональные, операционные и
бизнес-данные хранятся и управляются в
инфраструктуре, контролируемой клиентом, а
конкретные операционные данные, связанные
с RPA, передаются между облаком Automation
Anywhere и инфраструктурой клиента. Вся
ответственность за конфиденциальность данных
и соответствие требованиям возлагается на
клиента.

On-Premises с обновлениями через Cloud Благодаря Automation Anywhere On-Premises
с обновлениями через службу Cloud все
персональные, операционные и бизнес-данные
хранятся и развертываются на сервере в
локальной сети клиента. Вся ответственность
за конфиденциальность данных и соответствие
требованиям возлагается на клиента.

В следующей таблице перечислены обязанности по обеспечению безопасности данных и операций.

Требования к данным Cloud С поддержкой облака On-Premises с
обновлениями

через Cloud

Инфраструктура и
безопасность данных

Automation
Anywhere Cloud

Общее Cloud
клиента и

Automation Anywhere

Клиент

Непрерывность
и аварийное

восстановление

Automation
Anywhere Cloud

Общее Cloud
клиента и

Automation Anywhere

Клиент

Высокая доступность Automation
Anywhere Cloud

Общее Cloud
клиента и

Automation Anywhere

Клиент

Локализация данных Automation
Anywhere Cloud

Клиент Клиент

Конфиденциальность
данных

Automation
Anywhere Cloud

Клиент Клиент
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Требования к данным Cloud С поддержкой облака On-Premises с
обновлениями

через Cloud

Обновление ПО Automation
Anywhere Cloud

Общее Cloud
клиента и

Automation Anywhere

Клиент

В следующей таблице перечислены типы данных и места хранения.

Тип данных Cloud С поддержкой
облака

On-Premises с
обновлениями

через Cloud

Бизнес-данные
клиентов
• Персональные

данные клиентов
• Бизнес-данные,

используемые при
автоматизации

Cloud. For more
information on Cloud
storage information,

see Automation
360 Cloud FAQ.

Клиентская сеть Клиентская сеть

Операционные
данные
• Операционные

пользователи,
функции, пароли

• Информация об
устройстве

• Учетные данные
устройства

• Расписание Бот
• Определение Бот
• Журналы аудита и

приложений
• Workload

management
definitions and
schedules

Cloud Клиентская сеть

Совместное
управление:

Cloud
Обновления

пакета
действий

Клиент
Управление

всеми
другими
данными
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Тип данных Cloud С поддержкой
облака

On-Premises с
обновлениями

через Cloud

Персональные
данные
• Имя пользователя и

пароль
• Ключ безопасности
• Информация

об устройстве
пользователя и
учетные данные

• Доступ к устройству
Bot Runner

• IP-адрес/FQDN
устройства Бот

• Учетные данные
приложения Бот

• Журналы
приложений
пользователей

Cloud Клиентская сеть Клиентская сеть

Securing the RPA environment with external controls
The Automation Anywhere architecture consists of a standard desktop and server class infrastructure for
the registered devices and the Control Room.

RPA platform

This topic details the best practices for securing the RPA platform with external security controls. Network-
based firewalls, Intrusion Detection Systems, anti-malware, and external log servers are all standard
security controls that are relevant to RPA deployment and the other infrastructure in your environment.
The following figure shows logically where these components are deployed in the RPA deployment:
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In the image, Control Room components are shown in orange and data center components provided by
your organization are shown in blue.
Each external security control is discussed in detail in the following sections, in terms of placement and
configuration. Supporting network services such as Active Directory, SMB File Share, Microsoft SQL Server,
and production applications, and are accessed through network firewalls or directly, depending on their
placement relative to the RPA components.

Network-based access control to protect RPA with firewalls

Network-based firewalls and local server-based firewall are used to protect the Control Room or all nodes
in a Control Room cluster. By default, required protocols on the Control Room are permitted from the
corporate network. Additionally, all clustering protocols are permitted only between the nodes in the
Control Room cluster. Network-based firewalls are used to isolate Development, Test, and Production RPA
environments from the corporate network and from each other.
For unattended automation environments, the Bot Runner are placed in a specific isolated network and
protected by a network-based firewall. Attended automations run from corporate workstations with the
Bot Runner Bot Agent installed and are protected via the corporate perimeter firewalls or internal firewalls
protecting the corporate desktop infrastructure, like any desktop.

Anti-malware to protect RPA from viruses and malware

The Automation Anywhere Bot Agent runs on desktop class infrastructure and is considered a corporate
desktop. Anti-malware or anti-virus software is used to protect the registered device environment from
malicious software in the form of viruses and malware.

Intrusion detection systems to protect RPA from direct attacks

Intrusion Detection and Prevention Systems (IPS) protect the corporate network by detecting network-
based attack through network traffic analysis. Like any other critical section of the data center, an IPS
protects the RPA platform at the egress point, behind the network-based firewall.

Independent categories for Bot Creator and Bot Runner
For logical separation of duties, Control Room divides automation users into two broad categories: Bot
Creator (development) users and Bot Runner (run-time) users.
Bot Creator exist on a separate Microsoft Windows system with its own credentialing system to create,
update, and unit test the боты on the Bot Creator. Bot Creator only upload and download ботs to and from
the Control Room. Users on the Control Room users have privileges to execute боты on Bot Runner but
have no access to the Bot Creator. This separation of duty constitutes a dual authorization by requiring
both the developer and the business user to create and execute the бот in conformance with NIST AC-3
best practices.

RBAC in Control Room
Control Room implements Least Privileges and Separation of Duties through a configurable Role-Based
Access Control (RBAC) capability that conforms to requirements in NIST AC 2, 3, 5, and 6.
All Control Room users are assigned one or more roles. Access are available based on the usage conditions
assigned to each role when users are a member. Authorized users can temporarily or permanently
suspend other users when needed. RBAC enforces session handling to prevent unauthorized access.
If an unauthorized user attempts to view session details or gain access, the Control Room cluster will
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prevent this progress and immediately terminates the unauthorized session. The unauthorized user will be
prompted to log in with valid credentials. Inactive accounts can be disabled.
The administrator controls are responsible for all security functions, consistent with best practices in NIST
SC-3: Security Function Isolation.
The Control Room includes segmented administrator roles by default. Many permissions are supported for
creating new roles.
Controls are implemented at the Control Room, Bot Creator, and Bot Runner layers, for NIST Access
Controls (AC) and Change Management (CM) guidelines. The following technical controls are implemented
to ensure access is governed through NIST Least Privileges.

RBAC on боты

Access is deny all and allow by exception based on roles, except for admin roles. Addressing NIST AC-17
(access control), NIST configuration managments for NIST CM-2 (base line configurations), access
restrictions for NIST CM-5, NIST CM-6, and NIST CM-7 (least functionality), and monitoring NIST CM-9 for
бот activity across the development, test, and production environment.

RBAC on Bot Runner
RBAC on Bot Runner facilitates complete isolation of one department Bot Runner seamlessly from the
remaining departments' Bot Runners.
Боты are executed from the Control Room cluster. Local бот executions are protected through multiple
layered security, and are designed to prevent fraud as a result from escalation of privileges on Microsoft
Windows. The Bot Runner are executed by Windows, addressing access control enforcement in accordance
with NIST AC-3 Access Enforcement and AC-6 Least Privilege for Code Execution.
If user roles does not have access to sets of Bot Runner, as a result, these users are unable to view the
Bot Runner' executions or remote scheduling automation. See (Role-based processing domains).

RBAC for Credential Vault credentials management
Credentials created in the Control Room are used across Bot Creator and Bot Runner.
These credentials are securely stored in the centralized Credential Vault to facilitate access control, and to
divide in logical groups called ячейки. These ячейки enable complete separation between the credentials
of one department from another.

Role-based permissions

Permissions for credential management-related roles include the following:

Manage my credentials and ячейки By default, all users can manage their own
credentials and interact with the ячейки to which
they have permissions.

Управление моими ячейки Allows the user to create and manage their own
ячейки.

Administer ALL ячейки User can do all the actions in the Admin row of the
Locker permissions table below.

Создать стандартные атрибуты для
учетных данных

User can set an attribute value that remains the
same for other users of that credential attribute.
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Locker permissions

Locker permissions are set when a ячейка is created or edited. A user can have the following permissions
in a ячейка:

Просмотреть
ячейку

Редактировать
ячейку

Удалить
ячейку

Add
participant/
owner

Remove
participant/
owner

Просмотреть
учетные
данные

Assign
credential

Remove
credential

User-
provided
value

Standard
value

Consume # #

Participate # #

Управление# # # # # # #

Own # # # # # # # # #

Администратор# # # # # # # # #

Задачи, связанные с данной
Создать учетные данные
Create a credential and add the required attributes.
Создать ячейка
Create a ячейка to group similar credentials to share with other users.
Ссылки, связанные с данной
Credentials and ячейки in the Credential Vault
The Credential Vault securely stores sensitive information such as passwords, account numbers, and social
security numbers in credentials and ячейки for use in automation tasks. It facilitates role-based access for
users of a Control Room and ensures that sensitive values are not stored in боты or on devices.

Role-based processing domains
The Control Room RBAC applies the least privilege principles to domains by implementing Processing
Domains, specifying role-based privileges and permissions at the боты and Bot Runner level.
RBAC is applied at a folder level to completely and seamlessly isolate one department бот from the
remaining department bots. If the user role does not have access to a set of боты, those боты do not
exist, thereby enabling the separation of duties across different domains. For example, finance and
accounting roles can access only the боты that automate their respective functions, and specific Bot
Runners can execute these боты. This is consistent to best practices as defined by NIST AC-4 Processing
Domains.
Authorized users assign various roles based on the business need.

RBAC on Audit Log
Audit is automated for all privileged and nonprivileged roles to conform to best practices, as defined in
NIST AC-6.
Access is view-only based on a deny all and allow by exception based on roles and domains as defined in
the Audit section 7 addressing Audit and Accountability (NIST AU 1 through 15) and as required by NIST
AC-2 Automated System Account Management. If a role does not have permission to view Audit Logs, then
the Audit Trail tab is not visible to all members of that role. Audit automatically captures all events related
to creation, modification, enablement, disablement, and removal of users, боты, Bot Creators, and Bot
Runner.
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RBAC on viewing бот activity
The Control Room Activity menu provides options shows the status of the Automation Anywhere
Enterprise automations. These options are: In Progress, Scheduled, and Historical.
Access to бот Activity status is deny all and allow by exception based on roles and domains as defined
in RBAC. Two levels of checks are applied to access the бот Activity data. The user is required to be a
member of a role that has access to view the Control Room. Users with Control Room access that can view
only the боты belonging to their departments, as applied through RBAC on боты.

RBAC on User Management
Access is deny all and allow by exception based on roles, domains as defined in RBAC. Only those users
with access to User Management can manage other users in system.
This permission is further divided into the following sub permissions:

Create Users Only those users that create new users from the
Control Room.

Edit Users Only those users that edit existing users from the
Control Room.

Delete Users Only those users that delete existing users from the
Control Room.

Authorized users assign various combinations of these access permissions to different sets of users and
roles based on the business requirements.

RBAC on roles and permissions management
Access is deny all and allow by exception based on roles, domains as defined in RBAC.
Users with access to roles and permissions management can create, edit, and delete roles in the system.
This permission is typically assigned to administrators and power users from across enterprises.

RBAC on бот schedules
Access is deny all and allow by exception based on roles and domains as defined in RBAC.
This permission is further divided into the following sub permissions:

Планирование запуска моих боты Only those users that create new schedules.
Редактировать мои запланированные
действия

Only those users that edit their schedules.

Удалить мои запланированные действия Only those users that delete their schedules.
Просмотреть и управлять ВСЕМИ
запланированными действиями

Only those users that manage (edit or delete) all
the existing schedules created by any user.

Administrators assign various permutation and combinations of these accesses to different sets of users
and roles based on the business requirements.

RBAC on license management
Access to license management is deny all and allow by exception based on roles and domains as defined in
RBAC.
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Only those users with access to license management permission are able to update the license from the
Control Room. A common license exists for all the users across Automation 360 for a specific Control
Room. The updated license is effective for all the Bot Creator and Bot Runners registered with the
corresponding Control Room.

Bot execution access by dynamic access token
The Control Room implements and enforces a Trusted Path for registration and authentication of Bot
Creator and Bot Runners in accordance with NIST SC-11 to protect against any attempt to execute
unauthorized ботs.
The Control Room issues new client access tokens or identifiers through hashing, signed by the Control
Room and sent to Bot Creators and Bot Runner over HTTPS. Every subsequent communication between
Control Room and Bot Creator or Bot Runner is serviced by the Control Room after validation of the
signature of the latest access token sent by the Bot Creator or Bot Runner. Each access token is unique to
every Bot Creator or Bot Runner. This ensures that even if an unauthorized user could bypass enterprise
security and access the system, the Control Room security restricts any damage.

Secure credential store through Credential Vault
The Automation Anywhere platform provides a centralized Credential Vault to securely store all credentials
and provision them to боты on an on-demand basis.
Use the Credential Vault to store other information deemed confidential or sensitive. The credential store
implements NIST controls IA-2 to uniquely identify and authenticate organizational users (or processes
acting on behalf of organizational users).
Sensitive information does not have to be stored in боты or on Bot Runner systems, the Credential Vault
facilitates a logical separation of credentials from the боты.
Credential Vault variables (credentials) are created in the Control Room. They are available to the Bot
Creator and Bot Runner who are assigned roles that provide them access to the ячейки that contain the
credentials.
The Credential Vault adds flexibility and dynamic character to боты because only the credential references
are present in the боты, and not the credentials. When боты are moved from one environment to another
environment, absolutely no change is required in the боты. Боты can seamlessly pick up the credentials
values applicable for the new environment from the Credential Vault of that environment. Additionally, the
Control Room automatically stores configuration-related sensitive data into the Credential Vault by default.

Credential Vault encryption
The Automation 360 platform offers the embedded Credential Vault and provides an extensive set of
safeguards to protect data at rest and in transit, but also while it is in use on individual systems.

Encryption keys and vault

During the Automation 360 installation process, the system generates an RSA 2048 bit public/private key
pair and an AES 256 bit key. The private key of the RSA 2048 pair is referred to as the Master Key, while
the AES 256 key is referred to as the Data Key. The Master Key is presented to the installing administrator
for safekeeping in a physically secure location off system. The public key is used to encrypt the Data Key.
Both the public key and the encrypted Data Key are then stored in the database. When in use, all keys and
encrypted data are placed in encrypted secure memory using the Microsoft Data Protection API (DPAPI).
During Automation Anywhere Control Room startup or reboot, the administrator is prompted to supply the
Master Key. The encrypted Data Key is retrieved from the database and decrypted using the Master Key.
The Data Key is now ready for use. As the system stores and retrieves data from the Credential Vault, the
Data Key is used to encrypt and decrypt that data.
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vault is used to store all system managed credentials and critical system configuration data. It can also be
used to store any other sensitive data used in an organization's automations. As a result, bot builders can
avoid the insecure practice of hard-coding credentials and other sensitive data/ arguments directly within
their automations.
Multi-layer authentication and fine-grained access control are essential for a tightly controlled environment.
So is end-to-end data protection, which is also necessary to maintain the confidentiality and integrity of
business-critical processes, sensitive data, and related credentials.

Мастер-ключ This RSA-2048 bit key is managed by an
administrator outside of the system. This key
unlocks the Credential Vault. The administrator
types the Master key each time the Control Room
is started. When the vault is open, the master
key is immediately erased from memory and it is
not stored anywhere in the Automation Anywhere
product.

Data encryption key This AES-256 bit key is stored in the Control Room
database and is used to encrypt and decrypt the
credentials at the time of storage or provisioning.
This key is encrypted using the Master key. The
Data encryption key does not leave the Credential
Vault at any time. Credential encryption and
decryption are done at the Credential Vault.

Protection of data at rest

In addition to encrypting local credentials and selecting runtime data used by bots, the Credential Vault
provides secure storage for sensitive configuration parameters and details pertaining to the integral version
control and email services.

Credential storage
All sensitive data is stored in the Credential Vault using AES-256 encryption.
These credentials are encrypted by the Credential Vault service to conform to NIST SC-28 and to prevent
unauthorized access or disclosure of credentials. Only encrypted credentials travel from the Control Room
to the Database server and are stored in the database in an encrypted form. The data encryption key
encrypts all credentials using an AES 256-bit key generated by a FIPS 140-2 Level 1 validated module to
meet the NIST IA-7, SC-12, and 13 requirements for implementation of mechanisms for authentication to a
cryptographic module that meets the requirements of applicable federal laws.
The data for Active Directory user credentials for autologin to Bot Runners is also encrypted and securely
stored in the Credential Vault with the бот credentials.

Credential provisioning to боты
Credentials are provisioned only during the execution of automation.
Bot Runner or боты do not store credentials locally. Credentials are provisioned only during the execution
of the automation. When the credentials are requested by Bot Runner, encoded (64 bit) credentials travel
from the Control Room to Bot Runner over HTTPS protocol. When the боты finish execution, credentials
are erased from the memory.

Cryptographic providers
Use only the listed supported cryptographic providers.
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Control Room

Cryptographic Provider Supported Version

AES-256

AES/CBC/PKCS5Padding

ECDHAES/GCM/NoPadding

HMAC-SHA256

PBKDF2 with HMAC-SHA512

RSA-2048

RSA/ECB/OAEP with SHA-256 and MGF1
Padding

All Bouncy Castle FIPS versions mentioned in the
Automation Anywhere Open Source Software
(OSS) Notice

See: Compliance and vulnerability scanning .

Безопасная запись
Вы можете включить или отключить создание снимка изображений бизнес-приложений, настроив
безопасную запись в Control Room.

Обзор

Если функция безопасной записи включена, Bot Creator или Bot Runner не могут делать снимки
изображений, значений или текстов в приложениях. В результате никакие конфиденциальные
данные не сохраняются в боты в виде изображений (намеренно или случайным образом).
Остальные данные автоматизации, например, сведения об объектах пользовательского интерфейса,
записываются и могут продолжать записываться, чтобы автоматизация работала бесперебойно.
Обладая правами администратора, вы можете применить эту настройку из Control Room для всех Bot
Creator и Bot Runner (для всех пользователей или для определенных функций пользователей).

Настройка безопасной записи

1. Войдите в Control Room как администратор.
2. Перейдите в раздел Администрирование > Настройки > Боты.
3. В разделе Безопасная запись щелкните Редактировать, чтобы задать настройки.
4. Выберите Включить.

Значение по умолчанию: Выключить.
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5. In the Recorder preview image tab, select one of the following options:
• Enabled: A preview of the image is shown in the Bot editor when the object is captured but

discarded after you refresh the Bot editor. The image is stored in the Control Room and deleted
after 60 minutes.

• Disabled: Image is not captured and not stored in the Control Room.

6. Выберите настройки в соответствии с вашими требованиями.

Вариант Действие

Все пользователи Выберите этот параметр, чтобы включить
безопасную запись для всех пользователей,
имеющих доступ к продукту.

Пользователи с
выбранными функциями

Чтобы включить безопасную запись для
пользователей с определенными функциями,
выполните указанные ниже действия.
a. В столбце Доступные функции найдите и

выберите функции, для которых вы хотите
включить безопасную запись.

b. Переместите эти функции в столбец Выбрано.

7. Сохраните изменения.

Authentication with Control Room
When a Bot Creator or Bot Runner tries to connect to Control Room, the credentials are encrypted using
AES (256 bits key length) and RSA (2048 bits key length) and then transmitted on top of the existing layer
of Transport Layer Security (TLS).
This extra layer of message level encryption provides protection against network stack issues (such as
Heartbleed where OpenSSL was leaking sensitive data from memory) and also adds protection to the
last hop of the connection when TLS is terminated at the load balancer. These credentials are decrypted
by Control Room and authenticated against the hashed (PBKDF2 and HMAC SHA512 algorithm) user
passwords or against Active Directory via Lightweight Directory Access Protocol (LDAP).
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Supported authentication methods for Automation 360 On-Premises
Review the authentication methods supported by Automation 360 On-Premises.

Supported authentication methods

• Active Directory using LDAP
• Active Directory using Kerberos
• SAML
• Local authentication using a database

The benefits of integrating with Active Directory include the following:

Easier adoption Integrates with an existing authentication solution,
compliant with the standards.

Maintenance All passwords and password policies are centrally
administered.

Better user experience Fewer passwords to remember.

Kerberos provides additional benefits over NTLM pass-through authentication.
• Open standard versus closed proprietary standard
• Mutual authentication of client and server
• Integration with smart cards for 2FA

Local authentication manages user passwords through the Credential Vault. Passwords are hashed using
the HMACSHA512 algorithm, which is keyed by the output of the Password-Based Key Derivation Function
(PBKDF2). User passwords are encrypted in transit through TLS 1.2.
All authentication and session management is handled through the well-tested Spring Security framework.
Kerberos integration is provided through the well-tested Waffle framework. SAML integration is provided
through the well-tested OneLogin framework.

Active Directory integration for authentication

Automation Anywhere offers seamless integration with Microsoft Windows Active Directory for access
to the Control Room, Bot Creator, and Bot Runner. When Control Room is integrated with the Active
Directory, all the Active Directory users with basic details are directly available in the Control Room without
any extra configuration. For Active Directory integration, user passwords stay in only Active Directory and
are not saved in the platform.
In addition to Active Directory authentication, the Control Room has its own controls to prevent
unauthorized access to anDynamic access token authentication of Bot Runnery automation data.
Dynamic access token authentication of Bot Runner

Bot Runner users can also configure their Active Directory credentials for Bot Runner machine autologin.
These credentials are saved in the centralized Credential Vault.

Multi-domain Active Directory support

Automation Anywhere platform architecture supports multi-forest multi-domain Active Directory
integration. Multi-forest multi-domain integration requires trust relationships between the forests and the
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domains. Refer to Configure Control Room for Active Directory: auto mode for details. Automation 360 On-
Premises can be configured with Active Directory global catalog server in a way that the Control Room,
Bot Creator and Bot Runner can all be in the same or different Active Directory forests and domains. This
gives the added flexibility and control for large-scale complex deployment where users are spread across
geographies.
Multi-domain support is provided out of the box and no additional configuration is required. The
Automation 360 On-Premises user provisioning from different Active Directory domains is also seamless.
It enables the Automation 360 On-Premises admin to centrally orchestrate the digital workforce running
across the globe.

Support for secure protocols
The Automation Anywhere platform supports secure protocols (TLS 1.2 and TLS 1.3).
• Deployment of боты from the Control Room to remote Bot Runners is done over secure communication.
• Upload and download of боты from the Bot Creator to the Control Room is done over HTTPS.
• Transfer of any information from the Control Room to the database and vice versa is done over secure

communication.
• Transfer of encoded credentials from the Control Room to Bot Runners is done over HTTPS.
• WebSocket communication with the real-time data service in the Control Room is done over HTTPS.

Network security overview
All communication between the Control Room, Bot Creators and Bot Runner is done using outbound WCF
TLS 1.2 communications and inbound HTTPS TLS 1.2.
Бот deployment to remote бот runners, provisioning of credentials, automation scheduling, and event
capture are done exclusively through the Control Room. Use only HTTPS in the production environment.
• The REST APIs use Distributed Cache Service to get shared cached data required for specific

functionality.
• The Scheduler Service makes REST API calls to run a task on a specific client machine at a specific

time.
• Real-time Data Service makes REST API calls to authenticate incoming connection requests. It receives

task execution progress updates by Bot Runner and sends that information to all connected browser
clients using WebSocket Secure (WSS) protocol.

• The Control Room makes REST calls for user authentication and repository operations, for example,
upload a task, download a task, or compare two tasks.

• The Control Room makes REST calls to the validate user session at regular intervals. The Control Room
deploys and runs a task on a specific device using Bot Agent. It uses a TCP/IP channel.

• The Scheduler Service makes REST calls for autologin credentials. It also communicates to the Control
Room to get a license and user session-related information.

• The Control Room makes REST calls to get autologin credentials for a logged-in device. It also
communicates to the Control Room to get the license and user session-related information.

Change management
Access restrictions for configuration management.

© 2023 Automation Anywhere. All rights reserved.     41



    Automation Anywhere - Изучение

Baseline inventory controls for Bot Creator, Bot Runners and боты

The Control Room provides a single-pane-of-glass on all automation operations and infrastructure,
providing a way to baseline the configuration of the environment. Inventory controls are maintained
through the application of RBAC and the use of the Бот Repository, Operations Room, and License
Management to establish a single point of control for Base Line Configurations (NIST CM 2) access
restrictions for configuration management (NI5T CM 5 and 6). Configure automated baseline reporting
using the auditing and reporting systems in the Control Room.

Change control and documentation RBAC

The Control Room RBAC provides a point of access control and management for all changes to the Control
Room, Credential Vault, Bot Creator, боты, and Bot Runner with an automated mechanism to prohibit
changes and report on any attempts to make unauthorized changes. The logging and auditing system on
the Control Room provides the reporting mechanism for change management to conform to best practices
as described in NIST CM-3 through 5.

Software usage and license management

The Control Room provides an automated mechanism for tracking and controlling the use of licensed
software across Bot Creator and Bot Runners, addressing NIST Change Management CM 10.

Dual authorization change management

Separation of duties is implemented at multiple levels. Dual authorization is achieved through separation of
control planes for the Bot Creator and Bot Runner. Only боты created by an authorized Bot Creator can be
executed by a separately authorized Bot Runner and only by a user who has been given the privileges to
do so by an administrator.

Identity and authentication
All automation actions, for example, create, view, update, deploy, and delete, across Automation 360 are
done only after Control Room authentication is successfully completed.
After authentication is successful, the platform applies a second mandatory level of access control
enforcement in the form of fine-grained Role-Based Access Control (RBAC).
The Control Room has its own controls to prevent unauthorized access to any automation data.

Password hashing
Password hashing does a one-way, permanent transformation of the passwords of the Control Room users,
inline with standard password management practices.
Control Room passwords are concatenated with a salt and then hashed using the
PBKDF2WithHmacSHA512 algorithm before being stored in the database.
• The salt is 256 bits in size and is randomly generated by a cryptographically secure PRNG.
• The HMAC SHA512 algorithm is used for hashing and provides additional security over traditional

approaches.
• A keyed hash provides protection against hash length extension attacks.
• SHA 512 bit key is larger than the commonly used SHA 256 bit key.
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• The key used for the HMAC is from the secure Password-Based Key Derivation Function (PBKDF2).
• Hashing is done for 100,000 rounds (based on NIST recommendations).

Every time a Bot Creator or Bot Runner authenticates against Control Room, its credentials are
authenticated against the hashed credentials.

Authentication failure messages
If an authentication attempt fails, the Automation 360 platform does not specifically state if the username
or password is incorrect. It only states that the supplied credentials are incorrect.
This is one critical information security requirement for Automation Anywhere customers and defends the
system against a brute force attack.
This authentication involves the following:
• Bot Creator, Bot Runner connection to Control Room
• User log in to the Control Room from the browser
• Connection from the Control Room to the SQL Server

All failed authentication attempts are logged. См. раздел Журнал аудита. Audit Log access is provided as
per RBAC and audit logs are made available on a read-only basis for all users.

Authentication for Bot Runner
Two layers of authentication are present for deploying the боты on remote Bot Runner.
The Bot Runner is logged on/connected/unlocked using the configured credentials. These credentials are
fetched from the centralized Credential Vault over HTTPS. This first level of authentication is done against
the Active Directory domain automatically, on behalf of the user and is called Bot Runner autologin.
After being authenticated, Bot Runner can be authorized to execute ботs independently and
asynchronously.
The following table shows what happens to the user session on the Bot Runner after бот deployment.

User session status
before бот deployment

During deployment User session after бот
execution finishes

No session exists Create a new session and deploy the
бот

Выход из системы

Разблокировано Deploy the бот Session remains unlocked

Заблокировано Unlock the session and deploy the бот Session is relocked

Отключено Unlock the session and deploy the бот Выход из системы

Dynamic access token authentication of Bot Runner
The Control Room implements and enforces a Trusted Path for registration and authentication of Bot
Creator and Bot Runners in accordance with NIST SC-11.
The Automation 360 platform protects the automation data against any attempt to subvert the path. The
Control Room issues new client access tokens, or identifiers, after a predefined time period. These tokens
are protected to conform to NIST IA-5 by being signed by theControl Room and sent to Bot Creators and
Bot Runner over HTTPS. Every subsequent communication between the Control Room and Bot Creator/Bot
Runner is serviced by the Control Room only after validation of the signature of the latest access token
sent by the Bot Creator/Runner.
The access token is unique to every Bot Creator/Bot Runner. This protects the system from an
unauthorized attempt to bypass security and execute an unauthorized бот, and is consistent with the best
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practices to conform to NIST IA-9 Service Identification and Authorization. These controls implement IA-3
for cryptographically based bidirectional authentication and attestation of Bot Runners and Bot Creator
before establishing connections. This also addresses requirements around unique, automated, identifier
management IA-4 for multiple forms of authorization and identification. Identifiers are dynamically
managed for audit and control purposes. Identifiers are used as authenticators and managed for
verification on initial deployment, revoke, and prevent reuse. There are no static, unencrypted, identifiers
in use by Bot Creators or Bot Runner and cached tokens are cleared periodically.

Defenses against common vulnerabilities
The Automation 360 platform provides some defenses against common attacks on applications.
The list below contains several examples of these attacks and the security controls in place to prevent
them.

SQL Injection (SQLi)

SQL injection is a high-risk vulnerability that can seriously impact the confidentiality, integrity, and
availability of a database. It enables an attacker to execute any SQL of his or her choosing inside the DB,
thus allowing them to read sensitive data, modify/insert data, and execute various operations.
The Control Room prevents SQL injection using query provided by the Hibernate framework.
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Cross Site Scripting (XSS)

Cross-site scripting is a high-risk vulnerability that can seriously impact the confidentiality, integrity, and
availability of any user web session. It enables an attacker to execute any JavaScript inside the victim's
browser, allowing them to spy on the user's input/output or take unauthorized actions on behalf of the
user. They could also redirect the user offsite to a malicious malware download or a credential phishing
page.
The Control Room prevents cross-site scripting using automatic output encoding provided by the ReactJS
framework.

OWASP Top 10

Automation Anywhere provides the following controls to protect against the OWASP Top 10:

Risk Control

A1: Injection All input is escaped before commands or queries
are executed.

A2: Broken authentication and session
management

See the identification and authentication section.

A3: Cross-site scripting All output is encoded before being returned.

A4: Insecure direct object references Centralized authorization via Spring Security.

A5: Security misconfiguration No default passwords, stack traces hidden,
secure server configuration

A6: Sensitive data exposure See the Security at rest and Security in motion
sections

A7: Missing function level access control Centralized authorization via Spring Security

A8: Cross-site request forgery Using authorization HTTP header

A9: Using components with known vulnerabilities Black Duck software composition analysis tool

A10: Unvalidated redirects and forwards N/A - No redirect functionality present

Compliance and vulnerability scanning
Review details about Automation Anywhere compliance and vulnerability scanning.

Secure software development life cycle (S-SDLC)

Automation Anywhere has implemented a development security plan and protocol that defines a specific
depth of testing and evaluation to be done by the Engineering team on each release, conforming with
best practices as defined by NIST SA-11 Developer Security Testing and Evaluation and NIST SA-15,
Development Process, Standards, and Tools. This plan has been documented and shared with the
Automation Anywhere Engineering teams.
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Veracode vulnerability scanning for static and dynamic code analysis

In each weekly build, during the development process and before every release, all Automation Anywhere
software is scanned for flaws using the Veracode tool. Automation Anywhere Enterprise meets the
requirements for the strictest security policy available in the tool, Veracode Level 5, which is defined as no
Very High, High, or Medium severity vulnerabilities. Analysis reports are available with each release.

Dependency analysis

In each weekly build, during the development process and before every release, all of the third-party
libraries and dependencies in Automation Anywhere software are scanned for known vulnerabilities using
the Black Duck tool. Automation Anywhere upgrades vulnerable libraries when new versions become
available. Analysis reports are available with each release.
All Critical/High vulnerabilities are fixed for each release. Medium vulnerabilities will be considered for fixes
in future releases depending on the scope of the Automation Anywhere releases. The list of OSS used by
the application is published for each release.

Penetration testing

Automation Anywhere does a penetration test through a third-party vendor before each major release.
Additionally, Automation Anywhere incorporates the feedback from penetration tests conducted by
customers, which includes some of the largest financial institutions in the world. Analysis reports are
available with each release.

Additional security controls
Automation Anywhere Control Room restricts the database connection configuration with the system
administrator account.

Restrict installation from database system administrator account

All the database level transactions are done with a nonsystem administrator account. The Control Room
installer passes the SQL Server 2012 certification test.

Autolock the device

When Automation Anywhere боты are deployed from the Control Room to remote Bot Runners, they revert
the Bot Runner system to its original state. For example, if the Bot Runner machine was logged off and our
бот logged into the machine, it logs it off after the automation execution finishes. This ensures that system
level security is not compromised.

Using SHgetKnownFolderPath function

Automation Anywhere software uses the SHGetKnownFolderPath function and Knownfolder_ID to
determine the full path to the special folders. This is a recommended practice from Microsoft and use of
this function ensures that system will never redirect automation data to any other folder, even if someone
attempts to hack the function call. This is also one of the InfoSec requirements of Automation Anywhere
customers.

© 2023 Automation Anywhere. All rights reserved.     46



    Automation Anywhere - Изучение

API level security

Automation Anywhere software does authentication and authorization level checks at the API level. API
calls are serviced only for those users who have permission on the automation data. Unauthorized users
cannot bypass system security through rogue API calls.

Clean uninstall

When Automation Anywhere Enterprise Client software is uninstalled, it leaves no trailing files or folders
behind. This clean uninstall of the Enterprise Client software complies with InfoSec policies.

Store data in Program Data folder

Automation Anywhere software allows storing of automation data in the Program Data folder, for the files
which must be edited by end users. Permissions are also set on the directory during the installation so that
the user can edit the content of the folder. This complies with the InfoSec requirements of Automation
Anywhere customers.

Protected handling of MSVC DLL files

Automation Anywhere Enterprise Client software uses MSVCxxx.dll files for automation purposes, but it
does not install these files by itself. Client software directly uses the DLL files installed by only the Microsoft
operating system. This ensures that client software does not overwrite the DLL files installed by Microsoft
and our customers do not have to worry about doing one more cycle of checking for any introduced
vulnerabilities.

Assembly manifest

All the executables (.exe file) of the Automation Anywhere Control Room and Enterprise Client software
contain the manifest files which describe assembly metadata, for example, filename, version number, and
culture. This makes our platform comply with organizational InfoSec policies.

Application path on network

Automation Anywhere supports configuration of reading and writing automation data to a location on a
network drive. This enables users to keep all automation data at one place.

Autologin without disabling legal disclaimer

When Automation Anywhere боты are deployed from the Control Room to remote Bot Runner, our
customers do not need to change security settings, for example, disable login page, disable legal
disclaimer, or disable screensaver. Automation deployment works seamlessly without disabling these
settings.
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Secure Java automation

The Automation Anywhere platform can securely automate even those difficult-to-automate business
applications which download the Java runtime environment (jre) during automation execution. Whenever
these applications are started, an Automation Anywhere agent gets associated with Java executable
noninvasive and automates the business application. After the automation finishes, the Automation
Anywhere agent is automatically terminated.

Automation in nonEnglish languages

Users can securely use German, French, Italian, and Spanish language keyboard characters through the
embedded automation commands in Bot Creator. This enables users to write data into these languages.
Automation Anywhere customers do not need to depend on less secure third-party libraries for this
automation.

General Data Protection Regulation guidelines
The General Data Protection Regulation (GDPR) is one of the strictest compliance frameworks for
maintaining privacy of personal data. The GDPR defines personal data as any data that can be used to
identify a natural person (Data Subject).
For the most current description of Automation Anywhere GDPR compliance statement, see Cloud
Automation Agreement and Privacy Policy for Automation Anywhere.

Automation 360 architecture and resiliency
Automation 360 is a single, integrated platform that transcends front office and back office technology silos
to automate business processes across all systems and applications, including both SaaS and legacy apps.
The Automation 360 platform is deployed using a distributed architecture.
Centralized management is done through a web-based server, called the Control Room, to manage all
development and execution of the digital workforce. The Bot Agent executes automation and are run time
systems installed on the devices.
The following image shows the architecture and relation between Control Room and Bot Agent:
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• *indicates that the Control Room creates a unique user name and device ID to persist in the public key
in the database.

• **indicates that device public key is validated by the Control Room and a new token is created.

The following table describes the flow and the actions that occur between the Control Room, Bot Agent
and the back end services (as numbered in the previous image):

Действия Описание

1 The browser sends the device token to the Bot Agent for registration.

2 The Bot Agent then registers the device request to create a public
key and a token.

3 The back end services of the Control Room sends a response to the
Bot Agent that the device has been registered with a unique user
name and device ID.

4 The Bot Agent sends a message to the browser that the device has
been registered successfully.

5 The Bot Agent sends a message to the back end services of the
Control Room to indicate that the JSON web token has been
authenticated successfully.

6 The back end services of the Control Room then validates the device
public key and establishes a Web Socket connection with the new
token.
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Control Room and Bot Agent resiliency

The following table provides you the behavior and resiliency differences between Automation 360 and
Enterprise 11.

User
action
Bot Agent в Automation 360 Bot Runner Client in Enterprise

11
Примечания

СлужбыInstallation services are run on
the local device.

Installation services are run
inside an active user session.

RegistrationDevice is registered to the
Control Room.

An active user is registered to
the Control Room.

Bot Agent service runs on the
local system.

АутентификацияControl Room stores the agent
public key in the database.

Control Room stores the
authentication key in the
memory.

In Automation 360, the Control
Room stores the public key
in the database. So when the
Control Room restarts, the
reconnection is accepted faster.
The Bot Agent is resilient across
Control Room restarts.
However, in Enterprise 11, the
Control Room reconnection
does not happen after a restart.

Развертывание
Бот
Priority of боты is verified at
deployment.
Когда боты ставятся в
очередь для пользователя Bot
Runner, боты с более высоким
приоритетом развертываются
раньше, чем боты с низким
приоритетом.
However, if a lower-priority
бот is already running, higher-
priority боты are deployed only
after the lower-priority бот
completes running.

Когда активен бот с
низким приоритетом, а
развертывается бот с высоким
приоритетом, система
приостанавливает работу
бот с низким приоритетом
и запускает бот с высоким
приоритетом.
После запуска бот с высоким
приоритетом работа бот
с низким приоритетом
возобновляется.

Advantage in Automation 360
is that lower priority боты are
not paused and complete their
deployment before the high-
priority боты are deployed.

Обработка
ошибок
Обработчик ошибок пакет
contains actions to easily
handle exceptions a бот
encounters and transfers
control to other actions within
that бот.

Обработка ошибок command
helps in debugging when the
TaskBot and MetaBot Логика
are run.

УстройстваConnected when device is
registered with the Control
Room.
Reconnects when the device
restarts.

When the Bot Runner Client
restarts or loses connectivity
with the Control Room, you
must re-log to the Client to
reconnect.

Bot Agent reconnects without
individually logging in to every
single device.
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User
action
Bot Agent в Automation 360 Bot Runner Client in Enterprise

11
Примечания

ReconnectionBot Agent reconnects
automatically if there is an
interruption.

The Bot Runner client needs to
be reconnected manually.

Бот registration in Automation
360 is more robust and can
reconnect automatically to the
Control Room.

Public
and
private
key

Public and private key is
generated at the time of device
registration.
This key is used to authenticate
to the Control Room.

Same behavior as in
Automation 360.

СлужбыBot Agent is run as a service.
When device reboots, the
services are automatically
connected to the Control Room.
Bot Agent continues to check
for connection even if the
Control Room is down by using
the public and private key.

Requires a client to log in and
perform tasks.

Remote
connection
Remote Desktop Protocol is
supported only on multi-user
devices.
The Control Room does not
maintain the RDP.

Remote Desktop Protocol is
supported on both single and
multi-user devices.
In Enterprise 11, Remote
Desktop Protocol connection
is established from the Control
Room and maintained by the
Control Room.

Auto-
updates
Control Room administrator can
choose to automatically update
the Bot Agent to a later version
using auto-update capability.

Auto-update option is not
available.

Auto-update reduces downtime
because each user is not
required to log in to the Control
Room to update the Bot Agent
installed on the user device.

Configuration
updates
Updates are pushed through
Cloud

No standalone configuration
updates, but you can change it
manually.
Enhancements to the
configurations are released as
patches.

Global
cache
Configure device settings to
automatically set a user's
current device as default device
after the user logs in to the
Control Room.

Недоступно
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User
action
Bot Agent в Automation 360 Bot Runner Client in Enterprise

11
Примечания

Loss
of
connection
from
Bot
Agent
to
Control
Room

Боты that are already running
run to completion during the
update.

In general, боты already
running can run to completion
during the update. Exceptions
are as follows:
• If the бот tags data for Bot

Insight, the бот will not run.
• Parent/child боты will run

to completion because the
child боты are downloaded
at the start of running the
parent бот. However, if child
боты are referenced using
a variable parameter, calling
those child боты need the
Control Room to be available
during parent бот runs.

• Боты that use workload
management (WLM) will not
run.

• If a бот is using values from
Credential Vault, the бот
execution might fail if the
Control Room connection
is interrupted or lost. This
happens as the бот fetches
the value from Credential
Vault at the time of use.

Scheduling resiliency

Device pools provide built-in high availability (HA) for the Bot Runner devices if your unattended license
is free to use. You are not tied to a single Bot Runner device, so if your device is unavailable for any
reason and your unattended license is free for deployment, your automation is not affected. The scheduled
automation will automatically run on the next available Bot Runner device, thereby providing high
availability.
См. раздел About device pools.

ЧАСТО ЗАДАВАЕМЫЕ ВОПРОСЫ ПО Automation 360
Подробные сведения и вопросы по новейшей платформе Automation Anywhere, Automation 360, см. в
настоящем разделе «Часто задаваемые вопросы».

Что такое Automation 360? Automation 360 предоставляет интуитивно
понятный браузерный интерфейс для
бизнес-пользователей, позволяющий
легко автоматизировать задачи и
мощные инструменты для разработчиков,
обеспечивающие создание автоматизации
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процессов, безопасность, управление и контроль
в масштабируемой инфраструктуре для ИТ.

Что входит в состав Automation 360? Все для создания боты, которые вам нужны
для автоматизации своих бизнес-процессов:
Control Room cluster, Bot editor, Bot Runner,
Universal Recorder, сертификаты безопасности
корпоративного уровня, поддержку, доступ
к Bot Store и курсы Университета Automation
Anywhere.

Как выполняется развертывание
Automation 360?

Automation 360 может развертываться On-
Premises, а также в Cloud.
Для развертывания Automation 360 On-Premises
установка производится на серверах клиентов.
Благодаря использованию веб-интерфейса
Bot Creator, установка или развертывание на
пользовательских компьютерах не требуется,
что приводит к значительному снижению
совокупной стоимости владения (TCO).
Automation 360 развернутый в Cloud, предлагает
готовое решение, в котором покупателям не
нужно беспокоиться о выборе поставщика
облачных услуг или любых других элементов
инфраструктуры. Automation Anywhere все
это берет на себя. Администраторы получают
полный набор функций для управления
пользователями, обеспечения безопасности,
управления и контроля, доступ к которым они
также получают с помощью своего веб-браузера.
Конечные пользователи могут получить доступ к
платформе с помощью своего браузера, войти в
систему и приступить к созданию своих боты.

Какие доступны дополнительные
возможности облачного хостинга?

Automation 360 можно разместить в AWS,
Microsoft Azure, Google Cloud, IBM, а также в
любой общедоступной, частной или гибридной
облачной службе.

Как доставляется Automation 360? Вы можете начать процесс автоматизации
с Automation 360 одним из указанных ниже
способов.
• Automation 360 (Cloud или On-Premises):

Automation 360 — это интеллектуальная
комплексная облачная платформа, которую
можно использовать для автоматизации
бизнес-процессов в системах и приложениях.
Для получения дополнительной информации
см. Сведения о Automation 360.

• Community Edition: Community Edition
provides a free web-based option for users
to experience a range of Automation 360 бот
creation capabilities. Community Edition может
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использоваться небольшими организациями
(менее 250 компьютеров).
Community Edition предоставляет одну
лицензию Bot Creator, которую можно
использовать для входа в систему на одном
устройстве и развертывания одного бот
за один раз. Количество автоматизаций,
которые вы можете создать, ничем не
ограничено, но вы будете иметь доступ
только к ограниченным функциям.
Для получения дополнительной информации
см. Начните с Community Edition | Community
capacity and limitations.

• Бесплатная пробная версия. Бесплатная
пробная лицензия предоставляет
30-дневный пробный период, который
можно использовать для оценки продукта
и принятия обоснованного решения.
Бесплатная пробная версия поддерживает
оба варианта развертывания, Cloud и On-
Premises, и предоставляет доступ к полному
набору функций вместе с полной технической
поддержкой в течение 30 дней. У вас будет
доступ к трем лицензиям Bot Creator и двум
лицензиям Bot Runner.
Для получения дополнительной информации
см. Пробные лицензии.

Какие языки сценариев поддерживает
Automation 360?

Automation 360 поддерживает JavaScript, Python
и VBScript.

Доступен ли Automation 360 на других
языках, кроме английского?

Да, Automation 360 доступен на 10 языках:
английский, французский, немецкий,
итальянский, японский, корейский,
португальский, испанский, упрощенный
китайский и традиционный китайский.

Как обновляется Automation 360? Для развернутого в Cloud Automation 360
клиенты всегда пользуются последней версией,
и Automation Anywhere распространяют
обновления на регулярной основе. Для таких
функций, как пакеты action, администраторы
и пользователи имеют возможность
протестировать последние версии пакеты,
прежде чем принять обновление.
Для клиентов On-Premises регулярные
обновления доступны на портале клиентов,
что дает администраторам возможность
поддерживать установку любой версии
по своему усмотрению в масштабах всего
предприятия.

Каковы аспекты конфиденциальности и
безопасности данных Automation 360?

Конфиденциальность Cloud Automation
Anywhere обеспечивается всеобъемлющим
набором функций безопасности, которые
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предоставляются либо автоматически, либо
настраиваются владельцем данных для
реализации защиты данных. Cloud Automation
Anywhere включает комплексную защиту и
шифрование данных как при передаче, так и
при хранении. No personal data goes outside of
the environment–unless you tell it to; it remains
completely under the control of the IT manager.
Чтобы клиенты могли доверять AAI Enterprise
Cloud, безопасность Cloud служб Automation
Anywhere обеспечивается на основе отраслевых
стандартов и концепций, таких как базовые
принципы NIST Cybersecurity Framework, AWS
Cloud Adaption Framework, Center for Information
Security (CIS) и т. д.

Является ли Cloud Automation Anywhere
высокодоступным решением?

Cloud Automation Anywhere развертывается с
использованием полностью сбалансированных
по нагрузке сред Control Room Automation 360,
развернутых на полностью высокодоступных
общедоступных облачных инфраструктурных
службах в пределах региона.

Реализована ли в Automation Anywhere
Cloud защита с использованием
аварийного восстановления?

Резервные копии создаются каждые 6 часов
в другом регионе (кроме Австралии, где
резервные копии хранятся в стране). Если для
основного региона объявлена авария, то для
всех участников, использующих резервную
копию, создается экземпляр в дополнительном
регионе. Ниже приведены текущие цели
восстановления.
• Целевое время восстановления (RTO).

Время, необходимое для запуска работы в
новом регионе с восстановлением данных
из последней резервной копии, составляет
6 часов.

• Целевая точка восстановления (RPO).
Максимальная продолжительность потери
данных при восстановлении составляет
6 часов.

Прим.:  Регион аварийного восстановления
может находиться в другой стране.

Понятия, связанные с данным
Automation 360 — заметки о выпуске
Review the new capabilities, changes, fixes (resolved issues), security fixes, deprecated features, and
limitations in each release.
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Automation 360 Cloud FAQ
Answers to frequently asked questions (FAQ) and related information provide insight into various aspects
related to Automation 360 Cloud.

Где можно найти обзор безопасности Cloud
Automation 360?

An overview and details about Automation 360
Cloud security can be found in this document:
Automation 360 Cloud Security and Data Privacy.

As a customer, how can I start using
Automation 360 Cloud?

The prerequisites and additional, optional steps for
getting started can be found on the Automation
Anywhere documentation portal at the following
location: Начните с Cloud Automation 360.
Для большинства клиентов основным
требованием является предоставление
безопасного доступа с помощью HTTPS к новой
среде Control Room, размещенной в Cloud
Automation 360. Если эта функция еще не
включена, вам необходимо открыть порт 443 в
вашем брандмауэре, чтобы разрешить внешнюю
коммуникацию по HTTPS от вашего браузера
и Bot Agent к Control Room. Когда Bot Agent
установлен, он устанавливает соединение через
веб-сокет к Control Room. На площадке клиента
не нужно открывать порты для этих входящих
соединений.

Does Automation 360 Cloud provide a
service-level agreement (SLA) for service
availability?

Yes, an SLA for 99.9 percent monthly availability
is provided for the customer's access to their
production Control Room environment. The
SLA does not include planned downtime for
maintenance and updates to the service. Если
клиент считает, что SLA не было выполнено,
он может потребовать кредит на обслуживание
через службу поддержки. Подробности можно
найти в нашем Availability Service Level Terms.

How does Automation 360 Cloud support
high availability (HA)?

Each customer's Automation 360 environment is
deployed using application load balancing across
highly available public Cloud infrastructure services.
Службы инфраструктуры поддерживают как
микросервисы, работающие на контейнерах
Docker в кластерах Kubernetes, так и
хранилища данных (базы данных, кэш, ведение
журналов, файловые системы, хранилища),
поддерживающих HA в нескольких зонах в
пределах региона. Both AWS and GCP public
clouds are used.

Поддерживает ли Automation 360 Cloud
аварийное восстановление (DR)?

Да, Cloud Automation 360 поддерживает DR.
Under a disaster recovery scenario the customer's
tenants will be brought up in another region using
the same URL and their Bot Agent will reconnect
automatically. In case of major incidents, where
imminent resolution seems unavailable, a disaster
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situation is declared and all the tenants within
the region affected by the incident are failed over
to another, remote region. Текущие задачи по
восстановлению заключаются в следующем:

Целевое время
восстановления
(RTO)

The time taken to get
a new region up and
running with the last
backup data restored is
4 hours.

Целевая точка
восстановления
(RPO)

The maximum duration
for data loss during a
restore is 4 hours.

Прим.:  RPO вычисляется на основе созданных
резервных копий, перенесенных в другой регион
резервного копирования.

Существуют ли окна технического
обслуживания для Cloud Automation 360?

Yes, Automation Anywhere updates Automation
360 Cloud every 3 months so that customers will
receive automatic and regular updates to the
latest software version. Подробнее см. в разделе
Automation 360 software lifecycle policy.
Основным каналом для передачи информации
о сроках состояния Cloud и окон обслуживания
является Automation 360 Cloud Service Status site. Вы
можете подписаться на этот веб-сайт и получать
обновления. Note that you cannot choose when
the updates are rolled out across the multitenant
Cloud. The Automation 360 architecture is designed
to allow these timeless updates to roll out without
affecting customers' бот development lifecycles.

As a customer, what actions should I take
to plan for an Automation 360 maintenance
window?

A customer's бот operations should take account
of scheduling боты to run outside of the published
maintenance windows. These updates are
scheduled to run outside of normal business hours
on the same day and time per region, and focuses
on mid-month, avoiding month ends. More details
guiding customers on planning around maintenance
windows can be found on this KB article: Automation
360 Cloud updates.

Хранятся ли данные о клиентах в Cloud
Automation 360?

Да, базовые процессы автоматизации позволяют
клиентам хранить бизнес-данные клиентов
в собственной инфраструктуре с помощью
аккуратного создания бот. Однако, приложения
Automation 360 все чаще хранят данные
клиентов в Cloud. Несколько продуктов
Automation Anywhere хранят данные клиента как
часть определенных клиентом автоматизаций,
хотя, как правило, только временно, то есть в
течение процесса автоматизации, определенного
клиентом.
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Пример.
• IQ Bot use typically involves uploading images

for processing.
• Средство записи and AISense Recorder store

recorded screenshots.

Прим.:  Secure recording can be enabled by
administrators to ensure that these are not
stored.

• AARI хранит данные, обрабатываемые
сопровождаемыми формами.

• Bot Insight can be used to create dashboards
made from tagged business data being
processed by a бот.

• WLM stores Work Items in its queues.

Клиент контролирует, какие бизнес-данные
хранятся в Cloud Automation 360. Обратите
внимание, что исходные данные остаются у
клиента, и клиент контролирует удаление
данных в Cloud Automation 360. In general,
the business data a customer keeps in our
Cloud through the use of боты is for automation
purposes only and can then be deleted. Основное
хранилище данных находится не в нашем
Cloud. Customers might need to keep audit logs
and dashboard data. И то, и другое можно
экспортировать.

Что такое Политика хранения данных
Cloud Automation 360?

During a customer's subscription period, data on
the Automation 360 Cloud is in their control. Audit
logs have a retention policy maximum of 270 days.
Backups are taken every 4 hours and kept for seven
days. После окончания подписки, в соответствии
с нашей политикой хранения, данные
хранятся еще 30 дней для возобновления или
восстановления боты и отчетов, после чего
удаляются. По истечении 60 дней вся среда
участника удаляется.

Используется ли общая инфраструктура
хранения для данных, хранимых в Cloud
Automation 360?

Да. The data storage services used by Automation
360 Cloud are shared across customers as part
of the multitenant design. Таким образом,
инфраструктурные и эксплуатационные расходы
не перекладываются на плечи наших клиентов.
Automation Anywhere applications use a unique
tenant ID to ensure that data access is logically
segregated by tenant. Никакие операции по
обработке или хранению данных не могут
раскрыть данные одного клиента другому
клиенту.
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Могут ли сотрудники Automation Anywhere
получить доступ к данным клиентов,
хранящимся в Cloud Automation 360?

Да. However, operational controls governed by
Automation Anywhere compliance certifications
ensure that such access is limited to a well-defined
set of individuals in CloudOps, SecOps, and Support
organizations under strict separation of duties.
Доступ к данным клиента будет осуществляться
только на основании разрешения клиента для
решения обращения в поддержку.

Какие требования к соответствию
распространяются на Cloud Automation
360?

CloudOps is governed by the following certifications
based on third-party audits: SOC 1 Type 2, SOC 2
Type 2, ISO 27001, and HITRUST
Система управления непрерывностью бизнеса
Automation Anywhere также сертифицирована по
стандарту ISO 22301.
Клиенты полагаются на сертификаты отраслевых
стандартов в отношении нормативно-правового
регулирования и соответствия требованиям.
SOC 2 создан Американским институтом
дипломированных бухгалтеров (AICPA), и в нем
измеряются средства контроля безопасности
ИТ. The SOC 2 Type 2 certification verifies that
Automation Anywhere CloudOps and SecOps teams
have taken the appropriate controls and have put
operational processes in place to meet industry
standards for secure Cloud operations.

Доступны ли клиентам сертификаты
соответствия и сводные отчеты по
сертификации для ознакомления?

Да, теперь клиенты могут получить доступ к
различным сводным отчетам и сертификатам на
Security and Compliance Portal под NDA.

How does Automation 360 Cloud support
GDPR and an individual's privacy?

Automation Anywhere has put processes in place
to handle individuals' data privacy rights, and
reviews them on a regular basis to ensure GDPR
compliance. Для получения дополнительной
информации см. Privacy Policy.

Do Automation Anywhere personnel
monitor an Automation 360 Cloud tenant's
environment?

Да. Мы выполняем мониторинг всех журналов
аудита на уровне инфраструктуры и приложений
для обеспечения корректной работы среды под
нагрузкой. Таким образом, при достижении
пороговых значений нагрузки можно
задействовать дополнительные ресурсы для
обеспечения доступности и производительности
служб.

Does Automation Anywhere report
unsuccessful data breaches to a customer?

No, Automation Anywhere reports only successful
breaches to a customer when that customer's
data has been compromised and on a timeline
determined by local law.

What data does Automation Anywhere
collect to improve the Automation 360 Cloud
service?

To operate and support the service, Automation
Anywhere captures logs that can include
usernames from the system. Они заменяются и
перезаписываются каждые 30 дней. Automation
Anywhere collects and uses telemetry data only for
purposes of improving the service. Собираемые
телеметрические данные включают следующее:

© 2023 Automation Anywhere. All rights reserved.     59

https://www.automationanywhere.com/compliance-portal
https://www.automationanywhere.com/privacy


    Automation Anywhere - Изучение

• Журналы аудита: Они отражают действия
пользователя в Control Room и приложениях,
например бот был успешно запущен, или
пользователь создал бот.

Прим.:  Фактическое имя пользователя
замаскировано. Журналы могут включать
IP-адреса, имена устройств и имена бот.

• Пользователь щелкает функцию UX:
Помогает в предоставлении пользователю
специфической помощи и рекомендаций в
пользовательском интерфейсе на базе его
действий.

• Where documents are uploaded for processing
(for example, when using IQ Bot or AISense),
Automation Anywhere may reconstruct the
format of the document, without the customer's
data, for the purpose of further training
the Automation Anywhere AI/ML models to
recognize document fields that might contain
data for extraction. This aids in improving the
application's data extraction accuracy.

Эти телеметрические данные могут быть
использованы для мониторинга службы и видны
по Control Room арендатора, и в совокупности,
чтобы можно было оценить использование
и внедрение функций. Эти данные может
использовать группа управления продуктом
для определения приоритетных функций
для улучшения, а также для выявления
функций или приложений, которые не
внедряются. Эти данные также могут помочь
менеджерам-консультантам (CSM) рассказать
клиентам о неиспользуемых функциях, которые
они могли бы начать использовать и получить
преимущества.

In which geographical region is a customer's
data stored when using Automation 360
Cloud?

In general, for the pure Cloud deployment model, a
customer specifies the regional location at the time
of provisioning their Control Room instances, for
example, US East or Japan.
Обратите внимание, что мы не можем
предоставить подробный адрес или
местоположение физического центра обработки
данных, так как мы используем общедоступных
Cloud провайдеров, которые оставляют за
собой право на переезд и не раскрывают
местоположение по соображениям безопасности.
Мы предоставляем такую региональную
возможность, чтобы гарантировать, что Control
Room находится в том же регионе, где клиент
будет выполнять большую часть своих операций,
чтобы обеспечить высокую производительность
и удобство использования, а также уменьшить
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задержку. For most locations, for business
continuity, the disaster recovery element of the
service sends data backups every six hours to
another region. Другой регион обычно находится
в другой стране.

Какие регионы поддерживает Cloud
Automation 360?

Среды Automation Anywhere Control Room могут
быть размещены в следующих регионах:

Основная Резервное
копирование/DR

США (Запад) США (Восток)

США (Восток) США (Запад)

ЕС (Запад) ЕС (центральная
часть)

Япония Сингапур

Сингапур Япония

Бразилия США (Восток)

Бахрейн ЕС (Запад)

Индия Сингапур

Австралия -

ЮАР ЕС (Запад)

США (центральная
часть)

США (Восток)

ЕС (Запад 4) ЕС (центральная
часть)

Канада -

Что если клиент обеспокоен суверенитетом
данных (то есть сохранением данных в
определенном регионе)?

For customers concerned about data sovereignty,
the Pure Cloud model can only guarantee that
data is stored in the US, EU, and in Australia.
Это не препятствует доступу к данным из
местоположений за пределами этих регионов
(например, в целях поддержки). Для США регион
DR находится в пределах США.

Прим.:
1. The DR service is not supported in Canada and

Australia (specifically because most customers
in Canada and Australia are conscious of data
sovereignty).

2. For EU, we cannot guarantee that data is kept
within a specific country within the EU.
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Which public Cloud providers are used to
deliver Automation 360 Cloud services?

Automation 360 Cloud uses Amazon Web Services
(AWS) and Google Cloud Platform (GCP) to deliver
Automation 360 Cloud services. Automation
Anywhere decides on the default provider to use.
However, if you have a strong preference for AWS
or GCP, you should work with your account team to
choose the preferred Cloud service at the time of
closing the sales transaction. For existing customers
in the US and EU who provision for a new Control
Room, the new tenants are created in the same
region where your other tenants are located.

Прим.:
• IQ Bot classic is not supported on GCP.
• Migration of Enterprise 11 On-Premises Control

Room to Automation 360 Cloud service on
GCP using the Cloud Migration Utility is not
supported.

Что такое Control Room песочницы? A sandbox is a fully functional and supported
Control Room that receives new release updates
at least 3 weeks prior to a customer's main Control
Room for Bot Lifecycle Management (Dev/Test/
Prod). The sandbox environment primarily allows
customers to try out new releases and sanity-test
their production боты.

Прим.:  IQ Bot and DR are not supported on
sandbox environments.

Песочница это то же самое, что и пробная
среда?

Нет. В отличие от песочницы, пробная
версия или пробный концепт Control Room
предоставляется бесплатно в течение 30 дней
до продажи, как часть продвижения продаж
клиентам.

Частный Bot Store
Частный Bot Store is a secure internal бот marketplace for a company to post and share details and
documentation for all internally developed боты. Employees can easily discover internal боты and
commands to reuse in addition to all of the боты from the Automation Anywhere Bot Store vendors.
Use Частный Bot Store to perform the following tasks:
• View, access, and reuse боты to automate processes:

• Find and reuse боты built by your team
• Use filters to search for боты by applications, business processes, or a keyword
• Use боты from the Automation Anywhere Bot Store vendors
• Review detailed documentation provided with each бот to decide whether to use the бот

• Submit details and documentation about your own боты
• Use the Suggested bot idea page to submit a бот idea
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Use боты within your company:
• If required, email a бот developer for бот installation assistance
• Review and access боты in your Control Room

Use admin tools to help you with the following tasks:
• Review, approve, and publish боты
• Review your team's бот use case ideas
• Add or remove users and assign permissions

Watch the following video on how to get started with Частный Bot Store:

Понятия, связанные с данным
Getting started with Частный Bot Store
Use Частный Bot Store to view and submit боты and бот use cases within your company. Use admin tools
to review and publish боты and manage users.
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Learn
Learn about software policies and feature deprecations that impact Automation Anywhere products.

Release notes

Learn about what's new, changed, fixed, or the issues (limitations) in Automation 360 releases:
• Automation 360 — заметки о выпуске on page 65
• Community Edition — заметки о выпуске on page 641
• Automation 360 Package SDK Release Notes on page 712
• Process Discovery Release Notes on page 719
• CoE Manager Release Notes on page 721

Comparison matrices

Compare features between products to review feature parity and understand compatibility in order to
update or move to our latest product release.
• Матрица сравнения функций Automation 360 on page 725
• Матрица сравнения функций Automation 360 IQ Bot on page 740
• Automation 360 IQ Bot version compatibility on page 745

Software lifecycle policy

The Automation Anywhere software lifecycle policy aims to provide predictability, quality, and importantly
nondisruptive access to the latest innovations and enhancements so that you can control when and how
you want to adopt these enhancements.
См. раздел Automation 360 software lifecycle policy on page 746.

Cloud Service status

Our Automation 360 Cloud Service Status site shows real-time operational status, historical operational
status, maintenance information, and incident history for all Automation 360 Cloud services worldwide,
across all hosting regions.
См. раздел Automation 360 Cloud Service Status site on page 754.

Feature deprecations

Learn about features and capabilities (from Automation Anywhere or third party) that are deprecated or
nearing deprecation to understand how they affect your automation and what action is required.
См. раздел Feature deprecations affecting Automation Anywhere products on page 763.
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Automation 360 — заметки о выпуске
Review the new capabilities, changes, fixes (resolved issues), security fixes, deprecated features, and
limitations in each release.

Note:  Enterprise A2019 теперь называется Automation 360. Although the release notes for releases
earlier than Automation 360 v.21 reference the old product name, the content in these release notes is
applicable and relevant to Automation 360.

Use the links to view the release notes updates for each release.
Related concepts
Community Edition — заметки о выпуске on page 641
Ознакомьтесь с новыми возможностями в различных выпусках Community Edition Automation 360.
Related reference
Матрица сравнения функций Automation 360 on page 725
Используйте матрицу сравнения функций для сравнения функций Automation 360 с функциями в
Automation Anywhere Enterprise 11.3.x и версиях Enterprise 10.
ЧАСТО ЗАДАВАЕМЫЕ ВОПРОСЫ ПО Automation 360 on page 52
Подробные сведения и вопросы по новейшей платформе Automation Anywhere, Automation 360, см. в
настоящем разделе «Часто задаваемые вопросы».

Заметки о выпуске Automation 360 v.28
Дата выпуска: 22 March 2023

For Sandbox environment only

Important:  These release notes are applicable only to Automation 360 v.28 release for sandbox
environment (Сборка 17464). The .28 release for On-Premises is not yet generally available (GA), so the
content on these pages is subject to change until the On-Premises GA.

Review the top five features in this release as well as other new features and exciting enhancements for
Automation 360 v.28 release (Сборка 17464).

Highlights of this release

Here are the top five features in the v.28 release:

Document Automation and Google Document
AI

Validation-based improvement on Google Document
AI extractions: Empower your employees to
save time and automate more documents using
Document Automation and Google Document
AI validation feedback, which in turn provides
improved extraction accuracy for Document AI
learning instances.
Leverage integration update with the latest Google
Document AI parsers: Improve extraction accuracy
and enable 7 additional languages (including Italian
and Portuguese) for Document AI invoices, and
Japanese for Document AI expense receipts.
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CoE Manager: Value tracking for On-Premises
automations

Calculate ROI for automations running on an On-
Premises Control Room by running a бот to push
automation-run data to CoE Manager. View your
ROI data in real-time dashboards and create a
healthy pipeline of automations that will help propel
your business forward.
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Empower business users with Embedded
Automation and Microsoft Teams

Bring automation to your employees in their favorite
collaboration tool Microsoft Teams. Employees can
be in a chat or team channel, or open Embedded
Automation from the Apps menu to view a list of
the AARI processes and desktop automations they
have access to. They can start and monitor these
automations, without having to leave Teams.
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Workday пакет Easily automate your Workday processes such as
reporting, data upload/download, or triggering
workflows with our new point-and-click experience.
Our new пакет provides deep API-level integration
with Workday that enables you to build automations
easily, without having to code.

© 2023 Automation Anywhere. All rights reserved.     68



    Automation Anywhere - Learn

© 2023 Automation Anywhere. All rights reserved.     69



    Automation Anywhere - Learn

Enhance developer productivity Next-gen Recorder: Improve automation reliability for
web applications when the UI element is not visible
on the screen. The Recorder will automatically work
around this without any developer intervention.

Email automation through a shared mailbox: Automate
email tasks over a shared mailbox in Microsoft 365
Outlook using IMAP or EWS protocols and Client
Credential flow or PKCE flow with Exchange Online.
This feature saves you money, time, and effort in
maintaining individual personal mailboxes.
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Quickly search and replace any text or variables in the
action properties of the bot: Save time and improve
developer productivity with an automatic search
and replace tool in Bot Assistant. Users can quickly
search for any specific text or variable, navigate
through the search results, and selectively replace
each occurrence of the text or variable in the
automation.
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Bot runtime alerts: Gain visibility into your
automations with notifications on various
platform events and take actions based on these
notifications. Get notified on events such as
automation runtime and device pools from within
the application (default) or through email reports
based on your preference.
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Enhancement to bulk package update: As an
automation administrator, update multiple packages
in bulk or perform updates to specific боты and
view outcomes of these applied updates in a
system-generated report.
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What's new and changed in each product

Navigate to the following pages for details on all the updates (what's new, changed, fixed, and limitations)
in each product:

Рабочая область RPA v.28 release on page 75

CoE Manager v.28 release on page 92

AARI v.28 release on page 92

IQ Bot and Document Automation v.28 release on page 95

Bot Insight v.28 release on page 98
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Рабочая область RPA v.28 release
Review what's new and changed, and the fixes and limitations in Рабочая область RPA for the v.28
release.

Новые возможности

Control Room, devices, and Bot Agent

Select the Control Room services to run at startup (Service Cloud case ID: 00781074,
00804237, 00799057, 01260425, 01271130, 01793867)
You can optimize application process utilization on your device by selecting the Control Room
services that you want to automatically run at startup during the On-Premises installation.

Improved notifications administration to manage user access
A Control Room administrator can manage a user's access to the event categories set in the
Administration > Settings > Notification settings section. A Control Room administrator can
lock the required preferences and notifications only for those enabled event categories are sent to
the end users.

Monitor бот runtime, device pool, and license events through notifications
Through notifications, you can monitor all
• Бот runtime events: Бот runtime event notifications are sent to the respective users based on

бот access permissions.
• Device pool related events: Device pool-related event notifications are sent to users based on

their user role and permission in the Control Room.
• License events (such as license over subscription or consumption) - Email notifications are sent

for license over subscription or consumption events.

Monitor AARI events through Control Room notifications
With the Process events category, the Control Room notifies you about various AARI events
related to requests and tasks through notifications. The task and request event notifications are
sent to the task owner and request creator team, respectively.

Audit log event when a пакет is deleted (Service Cloud case ID: 01780700, 01885638)
An audit log event is logged when a user deletes a пакет.

Import intermediate certificates for secure access to Control Room (Service Cloud case
ID: 00673966, 01889608)
An intermediate certificate is used to determine if a certificate was issued by a valid and trusted
root CA (certificate authority). If the intermediate certificate is not installed on the server where the
TLS certificate is installed, applications might not trust the TLS certificate. To have clients trust the
TLS certificate, you must make the intermediate certificates available on the server.
You can import the intermediate certificates when you install the Control Room or after you install
the Control Room using the Windows command prompt.
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Control Room, devices, and Bot Agent

Validate remote deployments to avoid unauthorized device access (Service Cloud case ID:
01608589)
Prior to assigning a device for бот deployment, you can reset the бот running device for Bot
Creator, Непрофессиональный разработчик, and attended Bot Runner users to prevent
unauthorized deployments. This enhancement enables you to clear an existing бот running device
when users log into the Control Room and there is no Bot Agent available on the local device.

Configure username for different Automation 360 services using the CyberArk secret
response (Service Cloud case ID: 01852428, 00675147, 01950039, 00819460, 00830696,
00822765)
You can configure usernames for auto-login, Lightweight Directory Access Protocol (LDAP), and
service credentials using the CyberArk secret response. Usernames can be a combination of values
from the secret response or string literals. The CyberArk secret response contains field values that
you must enclose within dollar signs ($$) to construct the username. For example, to configure the
username in the format domain\username, you must enter: $$domain$$\$$username$$. The
domain and username values in this expression will be replaced with the corresponding values from
the secret response.

Customize device registration settings
Control Room administrator can customize the device registration settings while adding a device.
For example, if there are multiple users who will log into a single device, an administrator can
change the Device type to Multiple users.

Minimize security risk for trigger-based бот deployment
Prior to deploying a trigger-based бот, you can select to validate the device credentials for Bot
Creator, Непрофессиональный разработчик, and attended and unattended Bot Runner users. This
provides users additional security for trigger-based бот deployment.

Auto-connect to non-UI triggers for unattended users
As an unattended user who uses non-UI triggers (such as File/Folder trigger that do not require
user session) you can auto-connect to the Рабочая область RPA when the machine is rebooted.
You do not need to log in to ensure the triggers are running.
Service Cloud case ID: 00758775, 01754312, 01754887,01803179, 01844357,
01845563,01568082, 01866287, 01920491, 01951355, 01951355, 01957771

Пакеты, actionsи Bot editor

Workday пакет
You can use the new Workday package from Automation 360 to automate your Workday processes
such as reporting, data upload/download, or triggering workflows with our new point-and-click
experience. The package provides deep API-level integration with Workday that enables you to
build automations easily, without having to code.

Apigee пакет
You can use the new Disconnect and Resume Integration features in the Apigee package. You can
disconnect from your Apigee instance and clear the session using the Apigee Disconnect action. You
can resume an integration that is suspended in Apigee using the Apigee Resume Integration action.
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Пакеты, actionsи Bot editor

View mode supports the ability to copy
You can use the Copy to shared clipboard functionality to copy actions, triggers, and metadata
from a бот in a private repository that is in View mode. You can then use the Paste from shared
clipboard to paste the information to an editable бот.

Credential Picker listing enhancement
For easier navigation when you pick a credential, the Credential Picket option displays the
Locker, Credential and Attributes items alphabetically across the бот packages.

Extended attributes supported in the Эмулятор терминала Пакет (Service Cloud case ID:
01870633, 01928396, 01809815)
The TN3270E terminal type supports extended attributes. To enable extended attributes for
TN3270E terminals, select the Extended Attribute check box in the Connect action.

Enhanced Пакеты landing page
The Пакет Manager landing page has been enhanced to provide more clarity with consolidated
rows. When all versions of a пакет are disabled the status displays as Disabled. All related fields,
such as recommended Control Room version, Bot Agent version, and Last modified, will show the
status as Not Available.
The Version column has been renamed to Default version.

Enhanced error messages display errors from the child bots (Service Cloud case ID:
01264352)
When you create a бот where the parent бот calls a child бот, and if an error occurs in the child
бот, the error message provides the following details:
• Line number of the parent бот which ran the child бот.
• Line number of the child бот where the error occurred.
• Error message details, such as what went wrong with that line number and the corresponding

corrective action.

Timeout option in Database Connect action (Service Cloud case ID: 00753858)
We added a timeout option in the Connect action of the База данных Пакет. When you connect
with Microsoft SQL Server to automate database-related tasks, and if the database is down or
experiences any network issues, the automation will time out and fail if the database connection is
not established in the specified time.
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Пакеты, actionsи Bot editor

Improved readability with new formatting capabilities in XML document (Service Cloud
case ID: 01886455, 01925386)
When you insert, update, or delete nodes, the XML пакет does not remove carriage return
characters between nodes but does remove all blank text nodes from the XML document. By using
Prettyprint to format XML files, developers can easily improve the readability of a document.
Developers can save time by using the following new options that have been added to the XML
Пакет:
• Use Prettyprint: The Save session data action supports the Prettyprint format in the XML

document. When you select the Use Prettyprint check box and use the Insert node, Update
node, or Delete node actions and then save the XML document, the code is formatted with
proper indentation as per Prettyprint.

• Remove text nodes that contain only white space: The Start Session action provides an
option to remove blank text nodes when you parse the XML document.

New features added to the Эл. почта Пакет (Service Cloud case ID: 01835214, 01846425,
01756713, 01882482)
To support extensive process automation, we added the following action-related features to the Эл.
почта Пакет:
• Ability to use the Reply All action.
• Enhanced the Delete all action to delete all emails from a specific folder. Additionally, you can

apply filter parameters to emails such as:
• All, Read, and Unread
• Тема
• From a specific sender
• Before, on, or after a received date

• The dictionary variable for email properties includes a new variable, emailNoOfAttachments, used
to retrieve the attachment count.

Automate controls using Microsoft UI Automation (COM) technology
You can use the Microsoft UI Automation (COM) technology to automate the following scenarios:
• Capture and automate link controls
• Capture and automate tree controls

Insert Custom column in Таблица данных
A new Custom column option has been added to the Data Table > Insert column action that
enables you to insert a new column at a specified index in a data table. When you read an Excel
spreadsheet and assign it to a data table, you can modify the table by adding a new column and
entering any required data.

New Label option in Цикл пакет
A new Label option has been added to the Цикл пакет that enables you to break or continue a
specific loop from the nested loops.

Add and configure If action conditions
You can add and configure a maximum of 32 conditions in a single If action.
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Пакеты, actionsи Bot editor

Improved automation reliability for web applications
When you use the Recorder > Capture action to automate web pages running on Google Chrome
and Microsoft Edge browsers, the Recorder > Capture action no longer scrolls down the web
page if the target object is visible on the screen. By having a fixed top pane on the web page, the
user experience and automation reliability are improved particularly if some physical actions (such
as mouse clicks) do not work as expected.

Note:  Ensure that you install the browser extension (version 3.0.8.0) and use the Средство
записи пакет (version 2.10.2) to capture the control.

Preferred view retained as default view in the Bot editor
As a бот developer, you no longer have to manually select the preferred view when you open the
Bot editor. To improve the developer's productivity and user experience, when creating боты in
the Bot editor, your preferred view (List, Flow, or Dual) in the Bot editor will persist across user
sessions and browsers. When you navigate in the Control Room or after your next log in, the Bot
editor will retain your last used or selected view.

Line markers for collapsible sections of code in the Bot editor
When you create боты using Loop, If/If-else, Step, Trigger-loop, Try, Catch, and Finally
statements, the Bot editor clearly shows the collapsible sections. When building automations,
developers can use these visual indicator line markers at the beginning and end of the collapsible
section to improve their productivity.

Note:  The visual indicator line marker for the collapsible section applies only to the List view in
the Bot editor.

Enhanced user experience through refreshed and intuitive icons
With the new and intuitive icons for actions in the Bot editor, Citizen Developers and RPA
developers can quickly locate the correct action while creating automation for a day-to-day task.
These unique and renewed icons are developed according to brand and global standards.

Update to the Capture text of window action
The Capture text of window action in the Интеграция приложений пакет can be used to
capture a text from a window on two different user sessions.

Search and replace in Bot editor (Service Cloud case ID: 00792784, 01943783)
Use the Search and replace feature in the Bot editor to search for any text or variables, string
within an action and replace it.

The experience of building a process has improved.
• Copy, cut, and paste behaviors are the same in Process Composer as in the Bot editor.
• You can access hidden variables for all applicable conditions, through the variable picker in the

Process Composer.

The Process Composer supports Global Values. You can enter Global Values as variables and select
them from the variable picker.
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Пакеты, actionsи Bot editor

Upload Storage file action added to Process Composer package
You can use the new Upload Storage file action in a task бот to upload data to storage for
further consumption in a process. This makes AARI requests more versatile by enabling боты to
process files rather than requiring users to upload at request creation.

Building and running боты

Notification for бот import
You are informed through Notifications when you import a бот from the Control Room. However,
this notification is sent only to the user who imported the бот.

Bulk update of multiple пакеты to default version for multiple боты (Service Cloud case
ID: 00712719, 00728499, 00737694, 00803673, 01255722, 00838604, 00772147, 01760236,
01762679, 01771416, 01761859, 01782588, 01778220, 01784255, 01789551, 01809167,
01818690, 01831969, 01813413, 01287311, 01923711, 01927867, 01945464, 01946912,
01819540, 01945315)
You can update multiple packages to default version for multiple боты. This feature enables you to
update multiple package versions across all available боты with one action thereby increasing the
efficiency of a bulk package update. Additionally, you can review the боты and dependencies before
a bulk update.

Enhancements to code analysis
• You can access the new administration settings tab for policy management. The enable or

disable functionality of code analysis has been moved from Administration > Policies to
Administration > Settings > Policies.

• You can define multiple named policies with different rules that have different severity levels.
• You can apply different policies to different folders in the Automation page. When you run

code analysis on a file, it uses the applicable policy for the folder (assigned or inherited) where
the file is located.

Notifications integration in embedded automations
Notifications in embedded automations (such as Workday, Salesforce) provide you information
about automations initiated from these applications and remote бот executions. It enhances the
user experience by notifying you about the remote бот executions in their respective applications,
thereby increasing the notifications effectiveness.
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Building and running боты

Enhanced Automation Command Centre home page
The Automation Command Center (ACC) home page provides comprehensive visibility, actionable
insight, and oversight capability into all aspects of your automation domain. The ACC home page
provides operational insights such as automation and device status, license utilization information,
and code analysis policy compliance metrics.
This enhanced home page provides the following benefits and capabilities:
• Effective monitoring of the automation landscape, leading to:

• Improved reliability
• Improved utilization

• Ensures compliance by highlighting results of code analysis
• Helps CoEs scale efficiently and achieve automation success
• Easier navigation to other areas such as AARI, CoE Manager, and Bot Insight

APIs and integrations

Export repository bots by version or label (Service cloud case ID: 01805699, 01838251)
Use the new POST /v2/blm/export/version API to export repository bots by specifying the
label or version of the files. These bots are exported to an archived file.

Process composer APIs
Use the Process Composer APIs to create a new request from AARI processes. You can also
retrieve the initial form and request by specifying the reference ID. You can use the following
endpoints in the process composer APIs:
• /requests/create: Create a new AARI request.
• /requests/ref/{refId}: Retrieve a request.
• /processes/{id}/form: Retrieve initial form.

Изменения

Control Room, devices, and Bot Agent

Improved secure registration for Community Edition or Automation 360 users
When a user registers for the Community Edition or Automation 360 account, the registration email
sent to the user contains a temporary registration link used to create the user credentials. This
registration method is more secure than sending the user their password in plain text.
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Control Room, devices, and Bot Agent

Licenses page enhancements
To provide easy access to license usage and availability, the Licenses page includes information for
the following elements:
• License mode
• Control Room expiration date and time
• Date when the Licenses page was last updated
• List of products with license availability
• License total details and where used

Upgrade changes in code analysis policy from Automation 360 v.28 or later versions
If you have configured a policy for code analysis prior to upgrading to Automation 360 v.28, this
policy is migrated to Automation 360 v.28 and is named default policy. This policy is applied to the
Automation root folder and is applicable for all bots prior to Automation 360 v.28 release.

Active Directory enhancements for configuring domains (Service cloud case ID: 00733422,
01853744, 01862164, 01794663)
The following enhancements were made for administrators who configure domains for Active
Directory (AD):
• The Control Room login and the Create user pages automatically select the default domain that

is configured. You can select a different domain by either entering the letters of the domain or
selecting the domain from the drop-down list.

• You can configure the domains listed on the Control Room login, the Create user, and the
Create an Active Directory role mappings pages to hide domains.

Support for multiple roles in Active Directory role mappings (Service cloud case ID:
01133364, 01133364, 01929400, 01776684)
When you create multiple Active Directory (AD) role mappings for multiple security groups, the
roles used in the mappings are combined for the users who belong to the security groups.

Users who have an Attended Bot Runner license can no longer add Бот deployments to a queue.
However, there are no changes for triggers.

Пакеты, actionsи Bot editor

The name of the AARI Web package has been changed to Process Composer.

Исправления

Control Room now sends email notifications when a scheduled бот fails prior to its execution for
example, when the Bot Runner machine is not available.
Service Cloud case ID: 01768120
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The Schedule column on the Scheduled activity page shows the frequency of a scheduled бот
in your local language.
Previously, the frequency of a scheduled бот was not translated and not shown in the user's local
language, for example, Japanese.
Service Cloud case ID: 01936850

When you restart the Control Room services and execute a бот, the бот deployment no longer fails
on the connected devices nor generates an error on the In progress and Audit log pages.
Previously, the AtmosphereResource Cancelled error displayed on the In progress page and
the error was registered on the Audit log page.
Service Cloud case ID: 01937388

You no longer see duplicate deployments (current and previous) for the same device on the In
Progress page.
Previously, duplicate deployments were displayed.
Service Cloud case ID: 01954716

When you create a locker, the Create locker page displays tabs such as Credentials, Owners,
Managers, and so on.
Previously, tabs were not displayed.
Service Cloud case ID: 01949499

Attended Bot Runner users can view the Schedule bot menu on the following pages:
• Automation (Run bot > Schedule bot)
• In progress activity
• Scheduled activity
• Devices
• Device pools

Previously, this menu was not displayed on these pages.
Service Cloud case ID: 01085127, 01805063

If you deploy a task with a Bot Runner that has a disconnected default device and no device pool is
selected, an error message displays in your local language.
Previously, an error message displayed in English even when the user's local language (for example,
Japanese) was selected.
Service Cloud case ID: 01919213

The Bot Runner device will unregister from the Control Room only if there is a valid authentication
error.
Previously, during the Bot Runner authentication, the device was unregistered from the Control
Room after two unsuccessful authentication attempts. The reason for the error could be due to a
valid unsuccessful authentication attempt or any other error.
Service Cloud case ID: 01947943, 01946249, 01956026, 01945438
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You no longer encounter issues when you create a бот using the DLL Open and Close actions and
then use the If > Dll session exists condition to check whether a DLL session is closed in a бот.
Previously when you used the If > Dll session exists condition, it failed to check a closed DLL
session and displayed an error.
Service Cloud case ID: 01868691

When you use the Get node value to retrieve the JSON object in the JSON пакет, it returns the
JSON value in the correct format.
Previously, the Get node value action displayed the output in the wrong format.
Service Cloud case ID: 01864551

You can use the Connect action to establish a connection with the FTP/SFTP server with keyfile
authentication and automate a task.
Previously, the бот could not automate the FTP/SFTP operations if the SFTP keyfile server was
installed on a Windows machine.
Service Cloud case ID: 01858323

You no longer encounter any errors when you create a бот using the Create workbook action
from the Google Таблицы пакет.
Service Cloud case ID: 01918952

When you use the Connect action in the Active Directory пакет, you can select objects in the
Object Explorer window successfully.
Previously, an error was displayed when you selected objects in the Object Explorer window.
Service Cloud case ID: 01925109

In the Эл. почта пакет, you can use the Email > Send action to send an email without issues.
Previously, when you used Эл. почта пакет version 3.14.3-20220923-220748 or later, an
issue occurred when using the Email > Send action.
Service Cloud case ID: 01912097, 01931592, 01934137, 01940215, 01932494, 01942202,
01942055, 01946339, 01949164

You can create боты using the Run stored procedure action of the База данных пакет even
when you include a large amount of data as an Input parameter.

When you use the Connect action of the Эмулятор терминала пакет with the prompt value and
then the Wait action, the Wait action waits for the prompt value to appear on the terminal screen.

When a new пакет (first version) is added to the Control Room and you select Disable setting for
the new version of the пакет, the пакет will show the status as Disabled.
Previously, it showed the status as Enabled and set as default.

In the Datetime > Add action, you can now specify a fraction value in the Time value to add
field to increase the value in the Datetime variable by that specific fraction value.
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When you use any browser action to automate a browser window or a tab, and run the бот, the
browser action now waits for the time specified in the Time out after field to execute action on
the browser tab before the бот fails. Previously, the browser action failed after 30 seconds when
the бот did not execute successfully, regardless of the wait time set in the Time out after field
was less than or greater than 30 seconds.

Note:
• As a result of this fix, if the Time out after field has a value other than 30 seconds, you might

have to change the value for your existing боты. This will ensure that your боты continue to run
properly with the latest Браузер пакет.

• This fix does not apply for the Find broken links action.

Service Cloud case ID: 01880159

When you perform the following sequence of actions and then rename the variable that was used
in these actions, the name of the variable will now be updated for the Group conditions and the
conditions in the Condition tab:
• Use the Если пакет
• Add a specific condition with a variable
• Add a specific condition with a variable
• Сохраните бот.

In the Datetime > Subtract action you can now specify a fraction value in the Time unit to
subtract field to decrease the value in the Datetime variable by a specific time value and unit.

When you use the Capture action with the Средство записи пакет (version 2.9.x or earlier) to
navigate to another web page in the Google Chrome browser (version 105.0 or later), and then
use another Capture action to automate objects in the navigated web page, the бот no longer
encounters an error.

In any пакет, when you select the Add argument option, select String or Number as the
Argument type, and try to insert a value, you can now use the mouse to scroll or click the scroll
bar to navigate through the options.

When you use multiple Средство записи actions in a бот to automate a specific web page running
in Microsoft Edge with IE mode, and then run the бот, the second Средство записи action now
works properly, and the бот no longer encounters an error.
Service Cloud case ID: 01848824, 01868337

You can now use the Folder > Unzip action to extract compressed files and folders from an
AES-256 encrypted zip file.
Service Cloud case ID: 01854767

When you try to automate web applications, the Click action in the Средство записи now works
properly with the MV3 extension on Google Chrome and Microsoft Edge browsers. Previously, when
the object on a web page contained inline JavaScripts and the document to be automated was
secured, the Средство записи failed to perform the Click action.
Service Cloud case ID: 01927058, 01951022
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When you use the Click action in the Средство записи to automate applications running on
Microsoft Edge with IE mode, the боты now time out automatically and no longer freeze when a
pop-up appears during бот execution.
Service Cloud case ID: 01790352

When you assign a Production label to a TaskBot and deploy it, the бот no longer encounters an
error at the Image Recognition > Find window in window action and runs successfully.
Service Cloud case ID: 01825541

When you use the Средство записи пакет (version 2.10.2 or later) to capture a control on a
web page, select Currently active window from the Application tab and then run the бот in a
loop, the бот now captures the target control accurately and runs through all the loop iterations
successfully even if the control appears behind the бот runtime window.
Service Cloud case ID: 01904537

When you use any of the following actions to determine if a window does not exist, select the web
page opened in the Google Chrome browser from the list of active tabs in the Browser tab, and
then run the бот, the following actions now wait for the specified time value to close the browser
tabs before the бот fails.
• Window does not exist condition in the Если and Цикл пакеты
• Window with same title does not exist condition in the Если and Цикл пакеты
• Window does not exist condition in the Wait > Wait for condition action
• Window with same title does not exist condition in the Wait > Wait for condition action
• Wait > Wait for window action

Note:  When you run the бот, the actions might wait for an additional two to three seconds later
than the specified time out value to execute actions before the бот fails.

Service Cloud case ID: 00790336, 00822573, 00832864, 01268577, 01586174, 00790336,
01778857, 01804828, 01809565, 01791209, 01848262, 01867832, 01877740, 01959172, 01959278

When you create or delete a folder (or form) that contains .. characters in the folder (or form)
name, the folder structure no longer affected.
Previously, when you deleted a folder (or form) that contained .. characters in its name, the
parent folder was deleted which caused issues with the folder structure.
Service Cloud case ID: 01886058

The resiliency of the File/Folder trigger has been improved to continue listening after a network
disruption has occurred. Previously, a network error caused the trigger to lose connection with the
Bot Agent.
Service Cloud case ID: 01769532, 01773584, 01834098, 01867418

When you check in a бот that contains the string "bot_" in its name and some recorder metadata,
the metadata is no longer deleted. As a result, you can check out a бот without generating an
exception or error message.
Previously, the recorder metadata was deleted and you were blocked from making recorder
changes to any of the боты that contain "bot_" in its name. The бот checkout failed and
generated an exception or error message.
Service Cloud case ID: 01915726, 01933409, 01939124, 01944665, 01939124
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When you upgrade the Control Room to Automation 360 v.27, the work items are deployed
successfully for all scenarios.
Previously, when you upgraded the Control Room to Automation 360 v.27, the work item failed to
deploy when queues were paused or stopped.
Service Cloud case ID: 01948038, 01950948

When you run a бот with a queue and select the queue category, the task бот (that contains
a TABLE type variable and no row data) no longer fails and shows the Missing work item
template error message.
Previously, when there was no row content for a TABLE type variable, you could not select
the queue category while running a бот with a queue. As a result, the Missing work item
template error message was shown even if a template was mapped.
Service Cloud case ID: 01922641

When you compare бот versions from the View history Task Bot page in the public workspace,
the Compare versions displays any modifications made in the latest two versions of your бот
without any error.
Previously, an error was displayed if you used the Compare versions feature through the View
history Task Bot page.
Service Cloud case ID: 01949094, 01946533

After you update the Bot Agent to the 21.240.19897 version, you can deploy multiple bots using the
API without any failure caused by the AA-DB file size.
Previously, when you deployed multiple bots using the API the AA-DB.mv.db and AA-
DB.trace.db file sizes continued to increase and eventually caused the bots to fail. Additionally,
the device configuration refresh initiated message continuously displayed.
Service Cloud case ID: 01776544

The following issues were fixed on the In progress activity page:
• Active бот deployments no longer disappear after a page refresh.
• Duplicate бот entries were removed whose status was displayed as active.

Service Cloud case ID: 01937581

Variables that you configure as input type are encrypted in the log files generated for Control Room.
Previously, input type variables were not encrypted and displayed as plain text in the log files.
Service Cloud case ID: 01768904

Users can only view activities to which they have permission on the Activity > In progress page.
Previously, some users were able to view the activities of other users even though they did not
have permission.
Service Cloud case ID: 01839276, 01919244, 01940793, 01941503

In attended and unattended automation, if a бот fails to run and generates the "Node Manager
went Down unexpectedly and could not complete this bot execution." error, the start time on the
Historical and Audit log pages display correctly.
Previously, the start time was displayed incorrectly.
Service Cloud case ID: 01881736
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All users can view the scheduled activities on the Scheduled activity page.
Previously, some users were unable to view the scheduled activities.
Service Cloud case ID: 01885890, 01848429

The Control Room Access URL length is set to a maximum of 4,000 characters.
Previously, the URL length was not set.
Service Cloud case ID: 01923035

Sorting users using the Last login option on the Users page sorts users correctly.
Previously, sorting users by last login was not sorting the users correctly.
Service Cloud case ID: 01813134

If you have created a бот using the Rest API command, the REST GET command is parsed without
any errors even when the response body is empty.
Service Cloud case ID: 01922332

Japanese characters are supported in the Rest commands with multipart/form-data option and the
output PDF name is rendered correctly.
Service Cloud case ID: 01909753

All the files in the specified OneDrive location is downloaded successfully when you use the
Download file action from Office 365 OneDrive пакет.
Service Cloud case ID: 01886501

If you have selected the Read cell value option in the Read row action of the Расширенный
Excel пакет, the data from the next sheet of the specified excel file is extracted correctly using
Switch to sheet action.
Service Cloud case ID: 01904504

If a бот has Get multiple cells or Get Single Cell action from the Расширенный Excel пакет
to get the underlying scientific values, the values from the specified excel file are successfully
extracted when you run this бот.
Service Cloud case ID: 01882225, 01938812
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After updating to this release, exception errors are no longer displayed for the following actions in
the Excel advance package:
• Get single cell
• Get cell color
• Get multiple cell
• Get number of cells
• Get worksheet as data table
• Insert/Delete rows/columns
• Read cell formula
• Read column
• Read row
• Remove blank row
• Rename worksheet
• Replace
• Select cells/rows/columns
• Set call
• Switch to sheet
• Закрыть

Service Cloud case ID: 01780178, 01926325

If there are many (more than 500) боты deployed in one of the device when there are multiple
devices connected to a Control Room, бот deployments across other devices are no longer blocked.
Service Cloud case ID: 01791784, 01950118, 01904686, 01795862, 01945357, 01941048

If you create a folder with the same name as an existing folder in the private workspace, an error
message is now displayed, and the folder is not created.
Previously, a false successful folder creation message was displayed, but the last modified date of
that particular folder remained the same as that of the previously existing folder.

When you create, view, or edit roles and then navigate to the Bots section, the folder list is sorted
alphabetically making it easier to find a specific folder.
Previously, the folders were not sorted alphabetically, and it was difficult to find a particular folder
when there were many folders in the repository.
Service Cloud case ID: 01762755, 01843015, 01874823

When you import a бот using the overwrite option and do not have permission to access one or
more dependent folders, the import dependency is not broken because of the import failure on the
dependent folder.
Previously, importing the бот when you had no permission to access the dependent folder resulted
in a break in the dependency if the file or folder was already present.
Service Cloud case ID: 01929592, 01946078

When you import a бот that has more than 2,100 manual dependencies, the import is successful
without any issues.
Previously, the бот import failed when the бот contained more than 2,100 manual dependencies.
You had to reduce the number of dependencies to import the бот successfully.
Service Cloud case ID: 01913648, 01942373
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The group Managed Service Account (gMSA) provides functionalities such as install, update and
LDAP authentication within a domain, and also extends it across multiple servers.

Ограничения

(ID обращения к облачному сервису: 01833352)
When you want to move emails from one folder to another, and if you apply multiple filters such as
Subject, From specific sender, When received date is on or after, or When received date
is before, you cannot move an email when its sender id is: noreply@**.com.

Note:  You might observe this issue when you use Save All attachments, Delete All, Move All,
and Loop actions.

Обходное решение. Use only the From specific sender filter to move emails.

The Create User audit log entry page shows a valid device license even when the license
allocation for a user had failed.

In a clustered environment, when you update боты to the default пакет versions, the Bot update
list page shows Failed status and боты are auto-checked out even if they are updated with the
latest default пакеты.

In an Oracle environment, the Bot update list page shows an Code:
db.connection.exception error message.
Обходное решение.
1. Log in as an administrator.
2. Navigate to Manage > Packages and set the required пакет version as the default version.
3. Log in as a Bot Creator, and then check out and edit the бот.
4. In the Бот editor, click the three vertical ellipses at the top right corner.
5. Select required Пакеты and update the package version manually.

While updating боты to the default пакет version, when you select the Production label боты,
the пакет update is applied for the latest version of боты instead of the Production label боты.
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When you check out and edit a бот after the бот updates to the default пакет version, an error is
displayed in the System Date for these commands: SystemsDate, Веб-служба REST, and Число.
Обходное решение.
1. Edit the бот and navigate to Manage > Packages.
2. Set the Date and Time for the non-default пакет, and then set it back to the default Date and

Time.

Note:
• If previous version of the пакет does not exist, then upload the пакет and assign the

default Date and Time.
• If previous version of пакет is available, then edit the бот, assign it to the previous пакет

and save. Then, re-assign the бот to the new default пакет.

When a user (who created the workload automation) is deleted, work items are not processed even
if they are available to process. As a result, you must delete and re-create the automation.

If you select the Search type as Variable name in the Search and replace feature, the content
is not replaced when you use a number variable in the expression.
Обходное решение. To replace a specific variable in number expression, open that action and
change the variable manually.

(ID обращения к облачному сервису: 01950021) If Auto update is enabled for the Bot Agent in
Control Room, registered devices running Windows10 Enterprise might restart intermittently after
the Bot Agent update has completed.

Associated бот deployments fail if the Log collector option was enabled while updating
Automation Anywhere Control Room to this release.
Обходное решение. Ensure that the Log collector option under Administration > Settings
> Devices is disabled before updating to this release.

Ограничения из предыдущих выпусков

While running a бот in debug mode, the бот will fail if the variable size gets greater than 3 MB. An
error message appears showing that a variable has exceeded the 3 MB limit.

Feature deprecations

Review features and capabilities (from Automation Anywhere or other third-party vendors) that are
deprecated or nearing deprecation to understand how they impact your automation.

Deprecated weaker Transport Layer Security protocols: TLS 1.0 and TLS 1.1
Automation Anywhere has deprecated weaker communication protocols TLS 1.0 and TLS 1.1, and
their corresponding ciphers (Cryptographic algorithms) in Automation 360 Cloud deployments (AWS
and GCP). Automation 360 Cloud deployments support TLS 1.2 and later versions only.
Feature deprecations affecting Automation Anywhere products on page 763
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CoE Manager v.28 release
Review what's new and changed, and the fixes and limitations in CoE Manager for the v.28 release.

Новые возможности

Access CoE Manager from the Control Room
As an administrator, you can enable access to CoE Manager from the Control Room. This enhances
the user experience because the user no longer needs to open CoE Manager through a separate
browser tab. Once CoE Manager is enabled, users can directly access the CoE Manager login page
from the quick link section on the Control Room home page.

Support for ROI tracking in On-Premises Control Room
You can integrate both the Cloud and the On-Premises Control Room with the CoE Manager. This
enables you to monitor your automations and analyze the savings achieved. You can connect up to
3 Control Room instances in your CoE Manager.
For the On-Premises Control Room, to upload the бот activity data from the Control Room to the
CoE Manager, download and run the CoE Manager бот available in the Bot Store. To run this бот,
you must have a valid license such as a Bot Creator, Bot Runner, or a Непрофессиональный
разработчик.

Изменения

AARI v.28 release
Review what's new and changed, and the fixes and limitations in AARI for the v.28 release.

Новые возможности

Enhanced automation experience for Embedded Automation
We have improved the automation experience for your automation activities to run attended боты:
• As a prerequisite, you must have the Manage my activity permission to use the бот controls.
• When you run your attended automation, its progress, execution status, and controls for

pause, start (resume), and stop, are located on the new progress page inside the Embedded
Automation application.

• You can easily switch between the Automation tab to execute additional automations and
navigate back to the progress view, to monitor the running automations.
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Platform alerts and notifications
You will be notified with real-time message alerts based on recent automation events that occurred
Embedded Automation.
• The Notifications tab in the Embedded Automation will alert you of your automation outcomes

(failed, successful) and provide as detailed information for each бот, such as the start and end
times.

• When required, there is a short message describing if any specific issues occured.
• The New task assigned message will notify you if any new tasks were assigned to you, and

you can click that alert message to be redirected to the newly assigned tasks.
• Similarly, if you receive multiple new notifications, you can click the Load New Notification

message, located at the top of the notification list, to load additional unread notifications.

Stationary action buttons
While completing forms in AARI, action buttons are positioned in the fixed footer of the form. The
footer and its contents are responsive to the size of your window and adjust to fit buttons and
minimize the footprint.

Изменения

Enhancements to tags in embedded widget
These tag improvements provide a more accurate search and save you time when searching for
available tags:
• You can select and manage up to 500 tags at a time, in tag selector.
• Your search results will vary depending on the number of search terms you use with the most

recently created tags always showing at the top.
• You can use the search all tags option to search for all available tags.

Process level URL parameters
These process level URL improvements make it easier for you to pass URL data to your requests:
• You can pass custom data from applications to requests.
• Supported data types include: dates, time, number, text box, check box, radio button, text area,

and drop-down.
• Hidden variable types in a form are supported to receive URL data.

Improved formatting options for Label element
The Label element has been improved with new formatting properties where you can configure the
font sizes, colors, and text alignments in a form.

The name of the Process Editor has been changed to Process Composer to better reflect its
comprehensive capabilities.

Forms have improved responsiveness due to this next generation of form rendering technology.
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Users receive a notification in the Warning tab when a task is assigned or reassigned to them.
Service Cloud case ID: 01869263

Исправления

When you use a table element in your form which contains a text area data type, the text area
generates data from the database without issues.
Service Cloud case ID: 01905252

In a table cell field, when you enter Chinese, Japanese, and Korean characters, the characters
renders correctly.
Service Cloud case ID: 01914818

When you create a form with a column width that is less than 20% in Automation 360 v.26 amd
you open the form in the current version, the will now render without issues.
Service Cloud case ID: 01944387

In an AARI process, when you use the if/else condition, a process error no longer occurs when
you add the else if condition after the if condition.
Service Cloud case ID: 01949808

In AARI Web forms, the text area size renders as specified. Previously, the height did not render as
designed.
Service Cloud case ID: 01911488, 01910936, 01914476, 01924252, 01929268, 01946479,
01958805, 01961238

When filtering AARI requests by date, the date displays correctly.
Service Cloud case ID: 01915259

AARI forms works as expected when adding a new rule to an existing form.
Service Cloud case ID: 01925778

In AARI Assistant, the last runtime information no longer causes performance issues.

Ограничения

When you use the Search and Replace option to replace a form variable in a бот, the Search and
Replace option does not function properly and cannot locate the form variable.

When using a form with an image, users require the View permission to access the image and have
it render in forms.
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IQ Bot and Document Automation v.28 release
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.28 release.

Document Automation

Новые возможности

Standardize the format of extracted numbers and dates
You can configure your learning instances to convert extracted dates and numbers to a standard
format. This ensures consistency and accuracy in your databases and other systems of record.
For example, if you select to standardize dates to MM/DD/YYYY and a processed document
contains a date that appears as 12 Feb 2023, the learning instance will reformat the date to
02/12/2023.
If you select to standardize numbers to the English (United States) locale and a processed
document contains a number that appears as 100,00, the learning instance will reformat the
number as 100.00.

The new Document Workspace license tracks consumption for customers who brought their own
license for Google Document AI or Стандартные формы.

New Google Document AI features
• Validation feedback is available for new and existing learning instances that use Google

Document AI to extract data.

Note:  You must manually enable validation feedback for existing learning instances

• The invoices document type supports these additional languages: Estonian, French, German,
Latvian, Lithuanian, Portuguese (Continental), Romanian, Spanish, and Swedish.

• The receipts document type supports Japanese language documents and can extract two new
fields: payment type and last four digits of credit card.

New features for the Document Workspace dashboard in Bot Insight
• Create custom widgets
• The Validator performance by # of documents validated widget includes invalid

documents.
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Изменения

Download боты have the highest priority in a queue
To optimize system performance, the Control Room prioritizes running the download бот of
one process before running the extraction bot for another process. Previously, the system was
configured with the extraction боты at equal priority to the download боты, which created a large
queue of extracted data waiting to download.

Note:  For users with Control Room environments configured prior to v.28: The Control
Room admin must edit the aari-document-processor custom role to assign the new Set
automation priority to high permission.

Important:  New Community Edition users will have access to Document Automation
but not IQ Bot
As of Automation 360 v.27 release and later, only Document Automation will be provisioned to new
Community Edition users. New users will not have IQ Bot permissions, however, IQ Bot will be
available for existing, registered users.

Исправления

When you create a learning instance, the interface allows field names that start with a letter only.
Previously, the interface allowed field names to start with a number, which caused processing
errors.

The Test regular expression field supports a maximum of 100 characters.

You can create a learning instance with custom fields that do not have a field name and field label,
as long as the custom fields are unselected.

Document Automation extracts multiline fields without adding an extra space after each line.

Document Automation supports document processing on devices configured with an authenticated
or unauthenticated Proxy Auto-Configuration (PAC) file.

The Document Workspace dashboard shows the correct page consumption metrics for On-Premises
Control Room instances.

The "Average validation time" and "Validator performance by number of documents" widgets show
the correct values when you mouse over the data points.

In Document Automation, the correct error message is displayed while fetching a Стандартные
формы model that is missing configuration settings. Previously, an incorrect error message was
displayed.

While reconfiguring a table, you can add a table name within the 99 character limit and a table field
name within the 154 character limit. Previously, you could add more characters than the default
limit of 100 characters and 155 characters, respectively.

You can create a new project for Стандартные формы in the Linux environment. Previously, the
ability to create a project using Create project for Стандартные формы was not supported in
Linux.
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Ограничения

Document Automation поддерживает имя пользователя устройства длиной 17 символ или
менее.

Pattern-based validation is not enabled by default in imported learning instances. You must edit the
learning instance and select the Validation option in the Validation rules section.

Боты containing actions from the Document Extraction пакет do not support the advanced check-
out options.

For a public learning instance, if you delete a learning instance and then try to create a new
learning instance using that same name, an error is displayed.
Workaround:If you delete a learning instance as well as the learning instance folder, then you can
create a new learning instance using the same name.

When you create a learning instance with Google Document AI, an UNKNOWN option is
displayed under the OCR Engine filter in the Document Workspace dashboard.

If you apply a filter that includes User Name, Status, or OCR Engine, the Accuracy% by field
widget does not show the correct results.

If you submit a document that contains a validation error due to a regular expression, the page
keeps loading and you must refresh the page to continue. You cannot submit a document that has
a pattern validation rule with a regular expression that contains pipe symbol (|).
For example, the following expression has (|) characters and will show an error:
(^0[1-9]|[12][0-9]|3[01])-(0[1-9]|1[0-2])-(\d{4}$)
However, you can edit the regular expression in the learning instance and reprocess the document
to continue with validation.

As of Automation 360 v.28, document extraction fails via proxy in the bring your own key (BYOK)
use case.

IQ Bot

Исправления

If you test an invalid Python script when configuring custom logic, the system displays an error
message without any file path. Previously, the error message included the execution file path.

When you upload high-resolution or invalid documents to a custom group, if the document is not
processed, it is either moved to the validator folder or the fail folder. You can eventually download
the files from the fail or invalid folder.
Previously, the validator or the fail folder did not receive the uploaded files. You had to transition
the learning instance from production to staging and back again to move the file to the output
folder.
Service Cloud case ID: 01926196
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Исправления

The ability to create or edit a bot for a manual group has been fixed. You can now create a bot with
a manual group that has invalid or corrupted documents. You can also move the created bot from
staging to production and back again.
Previously, after creating a manual group for a learning instance with an invalid or corrupted
document, you were unable to create a bot.
Service Cloud case ID: 01878143

Ограничения

If the IQ Bot archive (IQBA) file size is above 268 MB, then the file storage does not upload
the exported file from the output folder to the desired location. You should restart the Project
Services from IQ Bot Services if the system is stuck and you are unable to perform any actions.

If IQ Bot Cloud is configured with a proxy server, learning instances cannot access Google Vision
API or Microsoft Azure Computer Vision OCR engine.

The maximum upload file size limit is set to 2 GB when importing and exporting files in the IQ Bot
archive (IQBA) file. If the file size is greater than 2 GB, then you must delete unwanted groups to
decrease the file size and migrate successfully. Earlier, maximum upload file size limit was 5 GB.

When you change from full screen mode to small screen mode in the Logic window, the Python
scripts and these options are hidden: Test Run, Clear Box, Fullscreen, and Save.
Обходное решение.
1. Click Logic to minimize the window
2. Click Logic to expand the window and view the Python scripts.
3. Place a cursor inside the Python script screen and click Enter.

For an existing Community Edition user, the Help icon is not available on IQ Bot interface.

If you are an Automation Anywhere free trial version user and you upgrade to Automation 360 v.28,
the Community Edition logo displays on the homepage. However, the functionality is not impacted.

Bot Insight v.28 release
Review what's new and changed, and the fixes and limitations in Bot Insight for the v.28 release.

Новые возможности

Enhanced Bot Insight filters and widget setting for Document Workspace dashboard
In a Document Workspace dashboard, you can use the custom dashboard filters to build custom
widgets. Additionally, you can edit the widget settings for an effective data visualization.

© 2023 Automation Anywhere. All rights reserved.     98



    Automation Anywhere - Learn

Исправления

For Bot Insight business analytics reporting, you can use the Bot Insight APIs to export all the
available data records from the Operations Боты dashboard's DataTable widget.
Previously, you could export a maximum of 100 records at a time from the Operations Боты
dashboard's DataTable widget.
Service Cloud case ID: 00760252, 01819244, 01857905, 01945720

Bot Insight Operations dashboard (which includes links to the Audit, Боты, and Device dashboards)
now retrieves and shows the complete volume count for a бот run.
Previously, due to a maximum volume count limit in KPI charts, the Bot Insight Operations
dashboard could not retrieve the complete volume count. Additionally, a maximum count of 10,000
was shown as the total бот run in the Боты dashboard which led to incorrect results.
Service Cloud case ID: 01825287

A user with the AAE_Bot Insight Consumer role can only view a published analyze dashboard.
The Delete dashboard action is greyed out and no longer available.
Previously, the Delete action was available and when the user tried to delete a dashboard, an error
message was displayed preventing the user from deleting the dashboard.
Service Cloud case ID: 01870477

Ограничения

In the Боты dashboard, the Total Bot Runs count does not match what the total count should be
when the Total Completed (Success), Total in Progress, and Total Failed counts are added
together.

Заметки о выпуске Automation 360 v.27
Дата выпуска: 11 January 2023

Review the top five features in this release and view other new features and exciting enhancements for
Automation 360 v.27 release.
• Сборка 16701: Automation 360 (Cloud and Cloud Sandbox) and IQ Bot (Cloud)
• Сборка 16685: Automation 360 (On-Premises) and IQ Bot (On-Premises)

We have released updated builds for fixes after the GA release of v.27 (Build 16667). For information about
the fixes in these updated builds, see Updated release builds.

Highlights of this release

Here are the top 5 features in the v.27 release:

Embedded smart forms and dynamic data
mapping for embedded widgets

Faster design and use of your embedded automation:
You can now design your forms using a responsive
and real-time canvas that automatically adjusts to
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the desired form size. This feature provides a faster
way to create embedded interfaces that interact
with any web applications. You can also configure
these forms in your business applications, such as
Workday or ServiceNow, to securely retrieve data
when embedded as an iFrame widget.
Eliminate data re-entry and save time: Use our new
PostMessage API to map and prepopulate data
from business applications in embedded widgets.
Dynamic data mapping provides safe and secure
communication of data from your business (host)
applications to initial process forms in the widget.

См. раздел Smart embedded forms and dynamic data
mapping.

Enhanced citizen developer experience Our updated and intuitive icons enable citizen
developers to quickly select actions and use the
Help for contextual information about actions,
providing a more seamless development of
automations. We have also enhanced the AISense
Recorder user experience so that you can use
anchors easily and automate UI objects that are not
detected by the recorder automatically.

See AISense recorder enhancements.

Strengthen governance and management Notifications: Our new notifications capability
provides a centralized, consistent, and proactive
medium for users to stay informed on their
automation estate and to take actions based on
the events they are alerted on. Alerts on various
platform events, бот events, and other automation
lifecycle events are delivered via in-app (default)
and email (based on user preference).

См. раздел Уведомления.
Automatically pick available Bot Runner users: Scale
your automations easily by selecting all the Bot
Runner users that can run a given automation
and the number of Bot Runner to use. This
capability ensures that when you run or schedule
an automation, the system automatically picks the
available run-as users from the specified list.

Standard forms Standard forms is now integrated in Document
Automation with the other document processing
capabilities. With enhanced accuracy, this feature
enables you to extract data from densely structured
forms including those with handwritten input. Use
cases for structured documents include tax forms,
mortgages, vehicle registration address, and so on.

См. раздел Using Document Automation for
Стандартные формы.
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PEG enhancements We continue to improve our Privacy Enhanced
Gateway (PEG) for sensitive information redaction
with a new configuration UI so you can easily
change the configurations in the UI instead of the
command line. We have also recently released a
new PEG serverless architecture for higher-scale
data collection use cases.

См. раздел Manage redaction and forwarding settings
from the UI.

Updated release builds

We have released the following updated builds:
• Build 16701 Service Cloud case ID: 01829572, 01947340, 01949323, 01950696, 01944637,

01951100,01953055, 01950639, 01951722, 01949415, 01949033, 01949372
• Fix for боты that were failing when all of these conditions were met:

• Бот contained more than 2,000 steps
• Бот had one or more nested actions (such as IF or loop)
• At least one of the nested actions contained more than 250 steps

• Fix for inconsistencies that were observed on the In-progress activity page.
• Fix for боты that were failing because of file dependency or interactive form that included multibyte

characters in file names.
• Changes to AARI desktop Assistant to manage and clear automations with start, stop, and resume

actions.

• Build 16685 (for US West, Canada, and Japan regions only) Service Cloud case ID: 01947340
This updated build includes a fix for this issue: If a бот has a file dependency and the file name
contains multibyte characters, then when the Bot Agent downloads the file, the download will fail
during run time causing the бот to fail as well.

What's new and changed in each product

Navigate to the following pages for details on all the updates (what's new, changed, fixed, and limitations)
in each product:

Рабочая область RPA v.27 release

• Updating to v.27 release
• Пакеты updated in v.27
• Migration updates for v.27 release

Обнаружение процессов v.27 release

AARI v.27 release

IQ Bot and Document Automation v.27 release

Bot Insight v.27 release

© 2023 Automation Anywhere. All rights reserved.     101



    Automation Anywhere - Learn

Ссылки, связанные с данной
Рабочая область RPA v.27 release
Review what's new and changed, and the fixes and limitations in Рабочая область RPA for the v.27
release.
Обнаружение процессов v.27 release
Review what's new in Обнаружение процессов for the v.27 release.
AARI v.27 release
Review what's new and changed, and the fixes and limitations in AARI for the v.27 release.
IQ Bot and Document Automation v.27 release
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.27 release.
Bot Insight v.27 release
Review the fixes in Bot Insight for the v.27 release.
Пакеты updated in v.27
Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.
Browser extensions for Automation 360
Создавайте автоматизацию из поддерживаемых браузеров с помощью расширений браузера.
Расширения периодически обновляются для поддержки улучшений и исправлений функций.
Поэтому убедитесь, что у вас установлены последние версии расширений для браузеров Google
Chrome, Microsoft Edge и Mozilla Firefox.

Рабочая область RPA v.27 release
Review what's new and changed, and the fixes and limitations in Рабочая область RPA for the v.27
release.

Новые возможности

Control Room, devices, and Bot Agent

Windows 365 Cloud PC now supported as Bot Runner (Service Cloud case ID: 01792699)
We support Windows 365 Cloud PC as a Bot Runner to create and run боты on Windows 365 Cloud
PC.
Automation 360 Bot Runner device requirements

Oracle Database is now supported on Linux (Service Cloud case ID: 00726728)
We now support Control Room with Oracle Database on Linux, so you can now choose to install the
Control Room with Oracle Database on Linux.
Installing Control Room on Linux | Database requirements
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Control Room, devices, and Bot Agent

Microsoft Edge offline extension is supported (Service Cloud case ID: 01829649, 01880289)
You can now install the Microsoft Edge offline extension for Microsoft Edge Enterprise browser users
even when the device is offline.
When the Bot Runner machines do not have Internet connectivity, you can use these features with
the Microsoft Edge offline extension:
• Automation of web apps
• User interface triggers
• Device registration

The Microsoft Edge offline extension is transparent and works similarly to the Microsoft Edge online
extension for users.

Установка Bot Agent и регистрация устройств | Browser extensions for Automation 360

Centralized notifications repository for various events and capability updates
You can now track all the platform and automation events through a centralized repository. With
this feature, you can identify the severity of events, consider possible actions based on the severity
of events, and then take appropriate actions. You can also be notified about platform updates, such
as бот export and package updates. Thus, it improves platform and user productivity.

Уведомления

Automatically select the number of Bot Runner (Service Cloud case ID: 00821020, 00715598,
00723191, 00784822, 01830238, 01870817)
You can enable Automation 360 to automatically select the Bot Runner users for specific tasks to:
• Scale automations easily
• Run боты concurrently
• Use resources efficiently

This capability ensures that when you run or schedule an automation, the system automatically
picks the available run-as users from the specified list.
Automatically select the number of Bot Runner users | Планирование бот

Manage domain accounts using gMSA (Service Cloud case ID: 00731119)
You can use a group Managed Service Account (gMSA) to manage and run Control Room and other
Automation 360 services.

Настроить учетные данные службы

View keyboard shortcuts in Bot editor
In Bot editor, you can now open a menu to view the available keyboard shortcuts.
Keyboard shortcuts

Validate device credentials prior to bot deployment
Prior to бот deployment, you can select to validate the device credentials for Bot Creator, attended
Bot Runner, Непрофессиональный разработчик, and unattended Bot Runner users. This provides
users additional security for бот deployment.

Переключение регистрации устройства между экземплярами Control Room
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Control Room, devices, and Bot Agent

Export roles to view users and their permissions (Service Cloud case ID: 01804955)
You can export selected roles and their permissions to CSV files to view the following information:
• User information
• Run-as user information
• User permissions
• Folder permissions

Export roles

TLS 1.3 encryption support for a more secure connection to Control Room services
(Service Cloud case ID: 00549240, 00606859, 01925085)
Automation 360 On-Premises supports both TLS 1.3 and TLS 1.2 cryptographic protocols for HTTPS
and TCP communications between our components.
Support for secure protocols | Configure application Transport Layer Security

Enhanced Automation Anywhere Debugger tool
The Automation Anywhere Debugger tool is available in the Bot Assistant utility to provide a
better user experience. When you invoke the Debugger tool from the Bot editor, you can add,
update, or delete actions and variables in a бот.
By default, the Watched variables lists is empty. With a single click, you can add all the used
variables in a бот. These variables display in a pop-up window where you can select or deselect,
one or more variables, from the list.
Debugger tool

Google Chrome and Microsoft Edge certification for operating systems
Google Chrome and Microsoft Edge extensions are certified for the following operating systems:
• Microsoft Windows Server 2012 Standard R2
• Microsoft Windows Server 2016
• Microsoft Windows Server 2019

Пакеты, actionsи Bot editor

Notification for пакет updates
When you add or update a пакет or upload a custom пакет to the Control Room, you are now
notified about this platform event. This notification is displayed to all the Control Room users
through the Notifications repository.
Capabilities supporting notifications | Add пакеты to the Control Room | Add custom package to your
Control Room | Upload custom package to your Control Room

ServiceNow пакет
You can use the ServiceNow package from Automation 360 to authenticate and perform several
actions with records and attachments in ServiceNow tables.
ServiceNow пакет
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Пакеты, actionsи Bot editor

ServiceNow triggers
You can use ServiceNow triggers to call an action when there is a new or updated record.
ServiceNow New Record trigger

Cut, copy, paste keyboard shortcuts added for TN3270 and TN5250 Terminal Emulator
In the Terminal Emulator пакет, the following keyboard shortcuts are now available specifically for
TN3270 and TN5250:
• Shift + Control + A = Select all
• Shift + Control + C = Copy
• Shift + Control + X = Cut
• Shift + Control + V = Paste

Using Send text action

Quick assistance at hand for the developers in the Bot editor
The accessibility and usability of the Bot editor, actions, and пакеты have been improved. As
a citizen developer or an RPA developer, when you are creating боты, you can quickly look up
information about the actions without navigating outside the Bot editor. Under the Actions pane,
quick help is enabled with contextual information about actions. Additionally, an icon is configured
with a link to the documentation. If you want more information about an action, you can click the
link, which redirects you to the relevant page in the documentation portal. This feature is currently
available in the following actions and пакеты.
• База данных
• Эл. почта

Enhanced user experience through refreshed and intuitive icons
With the new and intuitive icons for actions in the Bot editor, citizen developers and RPA developers
can quickly locate the correct action while creating automation for a day-to-day task. These unique
and renewed icons are developed according to brand and global standards.

Seamless пакет updates
When a пакет version is added to the Control Room, either from a Cloud download or Control
Room upgrade, as an administrator, you have the flexibility to disable the new version of пакеты.
This feature helps you to restrict users from using the new пакет version until it is verified.
Package updates | Автоматические обновления пакет для On-Premises Control Room | Automatic
пакет updates for Cloud Control Room

New option in Read from action of База данных пакет (Service Cloud case ID: 01263940)
A new check box is available when you use the Read from action to retrieve records from the
database and save the retrieved data in a CSV file. When you select this check box, no CSV file is
created if the executed SQL query does not return any data.

Proxy support for EWS-OAuth2 (Service Cloud case ID: 00771400, 01574715, 01815888)
When you create a бот with the Эл. почта пакет that uses EWS OAuth2 for authentication and
the Bot Runner machine is configured behind the firewall, then all outbound requests are routed
through the proxy server configured on the Bot Runner machine.
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Пакеты, actionsи Bot editor

64-bit ODBC driver now supported in База данных пакет (Service Cloud case ID:
01256142, 01829360, 01849908)
We now support connecting to databases by using the 64-bit ODBC driver. This option is available
when the connection mode is the default. Organizations transitioning to Office 365 will benefit from
leveraging this enhancement and can sustain automation build with 32-bit ODBC drivers.

Использование action «Подключить» для базы данных

OAuth 2.0 support in Эл. почта and Email trigger пакеты (Service Cloud case ID:
01798311, 01803702, 01791859, 01828526)
Microsoft is deprecating the ability to use Basic authentication in Exchange Online for these specific
protocols:
• IMAP
• POP3
• EWS

We support OAuth 2.0 authentication for these protocols in the Эл. почта and Email trigger
пакеты. For enhanced security, you can maintain the business continuity of your email automations
by switching the authentication type from Basic to OAuth 2.0, (as recommended by Microsoft).
Using Connect action for Эл. почта

Retry mechanism supported in credential variables (Service Cloud case ID: 01786319,
01887182)
The credential variables support the retry mechanism. When you create a бот that uses credential
variables, if the бот fails during run time to retrieve those variables from the Credential Vault
because the Control Room is disconnected or the Control Room services stop intermittently, then
the бот tries three times to retrieve the credential variables from the Credential Vault.

Прим.:  Ensure that the Bot Agent version installed on your system is the version that is released
with Automation 360 v.27.
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Пакеты, actionsи Bot editor

Support of other domain name in the Active Directory пакет (Service Cloud case ID:
01807358, 01910765)
We now support Active Directory user operations by logon name with domain and can provide the
domain name to extract user details. When you retrieve the user property or perform any user
operation based on the logon name (userPrincipalName), and if the user domain name differs from
the domain specified in the LDAP path, the user properties are now successfully retrieved with or
without a domain name.
For example, LDAP Path: LDAP://ADServer/DC=automation, DC=net

Пользователь Имя входа

userPrincipalName: kim@aaengg.net User can provide logon name as
kim@aaengg.net.

userPrincipalName: shaun@aasales.net User can provide logon name as
shaun@aasales.net.

userPrincipalName:sarah@automation.net user can provide a logon name as either sarah
or sarah@automation.net.

The following list of actions supports logon name with domain.
• Обновить сведения о пользователе
• Переименовать пользователя
• Удалить пользователя
• Включить учётную запись пользователя
• Отключить учётную запись пользователя
• Установить свойство пользователя
• Получить свойство пользователя

User account operations

Shared mailbox support for Эл. почта automation (Service Cloud case ID: 00797231,
01816574, 01829499, 01854615, 01871861, 01933058, 01834152, 01829684, 01853949,
01880386, 01869636, 01894591, 01867553, 01911371. 01925438)
The Эл. почта пакет supports the email automation of a shared mailbox in Outlook for Office 365/
Microsoft 365 using IMAP/EWS protocols, and OAuth 2.0 authentication using Client Credentials
and Authorization Code with PKCE grant flows. You can automate emails retrieved from a shared
mailbox and perform all email-related tasks by accessing each folder(s) and its subfolder(s) in the
shared mailbox.

Новое action в пакет Текстовый файл
You can use the new Read variables action in the Текстовый файл пакет to read the values of
variables from the text file.

Прим.:  The Import string from text file action in the Строка пакет has been deprecated and
will not be available for new боты. We recommend that you use the new Read variables action
with enhanced capabilities. This deprecation does not impact any existing боты or боты which were
migrated previously and they will continue to run properly. See Support and deprecation policy for
пакеты for пакет lifecycle and deprecation policy.

Read variables action
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Пакеты, actionsи Bot editor

Call an existing JavaScript function in a webpage
You can use the new Call a JavaScript function action in the Браузер пакет to call an existing
JavaScript function directly in a webpage or in an iFrame within a webpage in Google Chrome
and Chromium-based Microsoft Edge browsers. In the бот, you can also pass one or more input
parameters to the JavaScript function and process the return value from the function.
Call a JavaScript function action

Automate controls using Microsoft UI Automation (COM) technology
You can use the Microsoft UI Automation (COM) technology to automate the following scenarios:
• Capture and automate client controls
• Capture and automate password text controls
• Capture and automate page tab controls

Actions performed on objects captured with Universal Recorder | Capture using specific technology

Capture objects on applications running in administrator mode
You can use the Средство записи to capture objects on applications running in administrator mode.
To capture the object, select the Capture and run with admin privileges option from the Bot
editor.

Пакет Средство записи

Enhanced бот performance when using global values across боты
When you use global values across a parent бот and a child бот, the бот performance is enhanced
by reducing the бот execution time. To enable enhanced бот performance, you must set the Bot
compatibility version to 3 in the Advanced settings page of the Bot editor.

Прим.:  Ensure that the Bot Agent version installed on your system is the version that is released
with Automation 360 v.27.

Версия совместимости Бот

Enhanced user interface for Define functionality in AISense Recorder
• We have enhanced the user interface of Define window in the AISense Recorder that enables

you to use anchors easily and automate UI objects that are not detected by AISense Recorder
automatically. To improve functional clarity, the following object types are renamed:
• Active text is renamed to Link
• Passive text is renamed to Text value

• If you unintentionally click the screen or click before the highlighter appears, the AISense
Recorder provides visibility into it. You must confirm to capture the object again or use the
Define functionality to define the object on the screen.

• In the Define window, the AISense Recorder shows embedded help for each of the control
types so you can select the correct control types for custom objects.

Use variable anchor | Capture Textbox, Radio, Checkbox, and Combobox | Capture text value through
AISense Recorder | Capture link button through AISense Recorder | Capture Image button through AISense
Recorder
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Пакеты, actionsи Bot editor

New virtual key added to the Имитация нажатия клавиш package
In the Simulate Keystrokes > Keystrokes action, a new key named Return has been added
to the virtual keyboard for Enter functionality and the Enter key in the Number pad has been
renamed to Num Enter. As a result, the Return key is the main Enter key on the keyboard. This
enhancement keeps the keyboard in sync with the physical keyboard. The nomenclature has been
changed to avoid confusion between the Enter key on the keyboard and the Enter key on the
Number pad.

Support for global variable for all Datetime actions
In the Дата/время package, you can use the Datetime global variable across all Datetime actions.
You can select to use either String variable or a Global variable in the Source date and time
variable option. This avoids creating multiple local variables and reduces the total number of
actions used in a бот.
Datetime пакет

The resiliency of the File/Folder trigger has been improved to continue listening after a network
disruption has occurred. Previously, a network error caused the trigger to lose connection with the
Bot Agent.
Service Cloud case ID: 01769532, 01773584, 01834098, 01867418

Важное замечание:  For information about the supported packages for this release, see Пакеты
updated in v.27.

Building and running боты

Notification for бот export
When you export a бот in the Control Room, you are now informed through the Notifications
repository. This notification is sent only to the user who exported the бот.
Capabilities supporting notifications | Экспортировать боты

Code analysis runs automatically for all unscanned боты in public workspace
Code analysis now runs automatically on all the боты with the Not Scanned status in the public
workspace. This ensures visibility on the coding best practices for policies configured in the Control
Room and will show the results of code analysis for all the боты in the public workspace without
the need to run code analysis on each бот one by one.

Check out multiple боты and files (Service Cloud case ID: 00628344, 00822352)
You can now select multiple боты and their dependent files from different folders that belong to the
same process and check them out from the public to the private workspace. You can check out a
maximum of 10 parent боты, but there is no limitation on the number of dependent child боты.
Check out multiple боты

© 2023 Automation Anywhere. All rights reserved.     109



    Automation Anywhere - Learn

Building and running боты

Choose specific version of non-bot dependency to check out with parent бот
When you check out a parent бот, you can now choose the version of a non-бот file dependency to
check out. Every version of a parent бот can have different versions of non-бот file dependencies.
With this feature, you can roll back the dependencies while rolling back the parent бот. You can
make changes to a specific version of the dependent non-бот file.
Check out non-бот file dependencies

Compare бот version in private workspace (Service Cloud case ID: 01761840, 01771389,
01763432, 01904500, 00798356, 01780116)
You can now see the changes made to your бот logic in the private workspace before checking in
your бот. As a Bot Creator, it was difficult to identify the changes made to the бот logic, input, and
output parameters. With this functionality, you can now easily identify where you have made the
modifications to the бот logic, variables, triggers, dependencies, and packages compared to the
latest version or any other previous version of the бот.
Compare бот versions

Edit non-empty folder description in public workspace (Service Cloud case ID: 01820406)
You can edit the description of non-empty folders in the public workspace. Meaningful descriptions
provide more insight of the боты contained in that folder. This feature enables an administrator
or a user with rename folder permissions to better manage the repository when it contains many
folders.

Создание и переименование папок

Specify queue running times in workload automations (Service Cloud case ID: 01816260,
00331357, 01924895, 01274769)
You can set the specific time period when to run a workload automation. When creating the
workload automation, you can set the queue running days and time to ensure that the automation
does not run during these scenarios:
• Applications are not available
• During scheduled upgrades
• Non-working days (holidays, weekends)

Запуск бот с очередью

Check for duplicates when adding work items (Service Cloud case ID: 00825850, 01792046,
01806516)
You can check for duplicate work items before adding them to the queue. This feature prevents
re-processing the same work items multiple times, thus saving time and resources. You can either
move the work items marked as duplicate for re-processing or discard them.
Insert Work Items

Generation of API Key is audited
The generation of the API key is now audited and will display the expiry time of the api-key in the
audit logs.
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APIs and integrations

Workato Integration
You can integrate the Automation 360 platform and Workato by using the Automation Anywhere
connector. You can establish a connection with the Automation Anywhere Control Room and
perform various operations using the Control Room APIs.
Workato integration

SnapLogic Integration
You can now integrate the Automation 360 platform and SnapLogic. You can establish a connection
with the Automation Anywhere Control Room and perform various operations by using the Control
Room APIs.
Snaplogic integration

Боты RPA для Salesforce

Now when creating new connections, you have the option to include an API Gateway certificate.

Изменения

Control Room, devices, and Bot Agent

Automated reprocessing of failed WLM work items (Service Cloud case ID: 00825872)
When you create or edit a queue, you can now use the Max auto retry attempt option to ensure
that failed WLM work items are reprocessed automatically. With this option, you can specify the
number of times for which the automatic reprocessing of failed work items will be attempted.
Automatic reprocessing of failed work items is attempted after all the work items in a queue are
processed.

Better device management with improved device permissions (Service Cloud case ID:
01264963, 01871530)
You can now view and manage Bot Agent devices even if you have not registered them by using
the enhanced Edit the device(s) permission. The Edit the device(s) permission is improved as
follows:
• Device(s) from my device pools: To edit devices from device pools
• Run as users default device(s): To edit Run as user(s) default device

The Control Room administrator grants you access to a specific set of devices based on your role.
When the Edit the device(s) permission with the Device(s) from my device pools and Run as
users default device(s) options is selected, you can view and manage all (registered and non-
registered) devices from a specific accessible group.

Enhanced bot Compare versions page
The bot Compare versions page shows changes in the dependencies between two versions of
the бот. It shows changes for the first level of dependencies only and displays those dependencies
sorted in alphabetical order.
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Control Room, devices, and Bot Agent

Specify time period to put work item on hold (Service Cloud case ID: 00825875)
You can put a work item on hold for a specific date and time. This ensures that the work item
moves automatically to processing (new state) on the specified date and time and no longer
requires you to manually move it for re-processing. A new column in the Edit queue page displays
the hold status of the work item, either date and time or indefinite if you do not specify the date
and time.

Редактирование очередей

Пакеты, actionsи Bot editor

Control Room version compatibility check with specific пакеты
When you manually upload a пакет or a бот in the Control Room, the system now checks if the
specific пакеты used in the бот are compatible with the Control Room version.

Analyze button renamed in Bot editor
The analyze button of Bot Insight (Analyze Task Bot) has been renamed to Bot Insight
"Analyze" dashboard in the Bot editor page.

Исправления

Build 16701: This build includes the following fixes (along with fixes from the previous builds):

Fix for inconsistencies that were observed on the In-progress activity page.
Service Cloud case ID: 01949323, 01950696, 01944637, 01951100, 01953055, 01950639,
01951722

Build 16694: This build includes the following fixes (along with fixes from the previous builds):

If the Manage my activity feature is enabled for a user role, then the user can view the pause,
resume, and stop status on the In progress activity page. If this feature is disabled, then the
user cannot view these statuses.
Previously, users were able to view these statuses even when the feature was disabled.
Service Cloud case ID: 01937106

Build 16667: This build includes the following fixes:

When synching with the Active Directory (AD), the user mapping no longer overwrites the
Description field in the Control Room with blanks.

The Automation 360 Control Room no longer generates an error in the User Management log when
a mapped security group has no members.
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The In progress activity page no longer shows боты after they are run.
Previously, the page incorrectly showed боты in the active state even after execution.
Service Cloud case ID:

01914651, 01924866, 01923265, 01928088, 1918956, 01922321, 01931985, 01921849, 01938985,
01939812,
01940084, 01940585, 01940258, 01938868, 01934451, 01940222, 01941187, 01940900,
01941742, 01939639,
01941503, 01941496, 01939639, 01942720, 01942430, 01943379, 01943617, 01938885

When a user is assigned an admin role to create schedules and later the admin access is removed
for that user, an audit log will be logged when the schedule is canceled because of the user not
having the admin privileges.
Previously, when such schedules were canceled, no audit logs were logged indicating that the
schedule was canceled because the user did not have the required privileges.
Service Cloud case ID: 01830359

The Administration > Licenses page and the Control Room banner displayed on the same
licenses page now display correct information about license expiry.
Previously, the correct information about license expiry was not displayed.
Service Cloud case ID: 01807324

When you edit a role, the Edit role audit log page now displays the correct old, new, and run-as
user values.
Previously, these values were not displayed.
Service Cloud case ID: 01759116

When you edit your first or last name on the My profile page, the description and auto login
values on the Edit user audit log page will not be updated.
Service Cloud case ID: 01846878

You can correctly filter the status for activities on the Activity > Historical page.
Previously, some filters were not displaying the correct status for activities.
Service Cloud case ID: 01869361, 01875216

Users without permission cannot view the activities of other users on the In progress activity
page.
Previously, some users were able to view the activities of other users even though they did not
have permission.
Service Cloud case ID: 01911289, 01910582

If you configured the log collection level as Debug, the logs collected from some packages do not
include customer data.
Previously, the logs collected from some packages included customer data.
Service Cloud case ID: 01862053, 01870001
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If the CPU utilization and device memory threshold values are outside the percentage range defined
by the Control Room administrator in the Administration > Settings > Devices > Threshold
settings for multi-user devices, a clear error message now indicates the device unavailability
and provides an appropriate action.
Previously, when the CPU utilization and device memory thresholds values exceeded the defined
value, бот deployment failed with an unknown error message.

Device shows an accurate status when the Bot Agent is disconnected from the Control Room.
Previously, due to the default time (15 minutes) of the WebSocket connection, a device was shown
as connected even when the Bot Agent was disconnected from the Control Room.
Service Cloud case ID: 01843990

In the Oracle Database environment, a checked-in бот is now automatically refreshed and can be
viewed in the Public folder.
Previously, to view a checked-in бот in the Public folder, you had to manually refresh the
Automation page by using the Refresh button.

When a Stop Task command is used, WLM work items are now marked as completed successfully
and show the correct status in the Control Room.
Previously, WLM work items were marked as failed even if the бот was executed successfully.
Service Cloud case ID: 01841320, 01840748

When you run WLM automations, if the Control Room restarts during deployment, the WLM
deployment continues without delay when Control Room services are active.
Previously, after the Control Room restarted, there was a delay of 15 minutes before the WLM
deployment continued.

When you run a bot by using the Run bot with queue option, the correct value of the work item
is now selected, irrespective of the modification source. Previously, when the value of a work item
was modified through the API or bot setting, the older value was selected by the bot
Service Cloud case ID: 01786785

In an Oracle Database environment, when you select the number format and sort order for the
work items in a queue and then run bot by using the Run bot with queue option, the queues are
now deployed successfully. Also, the correct log entry is shown in the Audit log or Activity page.
Previously, queues were not deployed, and no errors were shown in the Audit log or Activity
page.

In a clustered environment, the бот deployment progress is no longer stuck and the Bot Runner
device connects to the Control Room successfully.
Previously, the бот deployment progress would get stuck sometimes and show an error message
Waiting for user: <username> and/or device: <device-name> on the In progress
> In progress activity page.
Service Cloud case ID: 01830285

When a бот keeps running for a few hours, an error no longer occurs due to high memory usage
with the Средство записи package version 2.9.2 or later.
Previously, an increase in memory usage caused the бот to fail after a few hours with a Java
heap space error.
Service Cloud case ID: 01911565
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When you read emails within a loop using a Microsoft Outlook Client connection with a subject filter,
use the Delete action and run the бот, the бот now completes the set iteration and deletes the
emails from the specified folder. Additionally, the variable that was used to display the count of total
emails versus deleted emails now displays the correct counts in the message box.
Service Cloud case ID: 01845642,01857791,01880424

When you establish a connection with the EWS server, and emails are read within a loop to filter
and move all emails from a subfolder created within the custom folder, the бот now executes
without an error.
Previously, an error occurred because the бот could not read the emails from the folders created
outside the predefined folder, such as Inbox, Junk, or Draft.
Service Cloud case ID: 01823238

You can now successfully create a бот by using the Upload file action from the Office 365
OneDrive пакет.
Previously, the бот displayed an error when you used the Upload file action and if the file name
had special characters such as brackets [].

Прим.:  Brackets [] are now supported in the file name.

Service Cloud case ID: 01798568

When you choose the variable option to perform a task and during бот creation process you delete
the variable you created (Your variables), and when you click the Add option in the variable field to
insert a variable (such as global variable), the option is now enabled.
Previously, the Add option for inserting the variable was disabled.
Service Cloud case ID: 01869139

When you create a бот, you can now use the Update node action of the XML пакет to update the
value of a node. Previously, the attributes were removed when you updated the text value of an
XML element.
Service Cloud case ID: 01805643

In the Эл. почта пакет, connect to the EWS server and use Loop > For each mail in mail box.
If the source mail is sent on behalf of some other user, for example, user xyz@aa.com sent mail
on behalf of user abc@aa.com, the email dictionary variable emailFrom now returns the correct
sender ID, which is abc@aa.com.
Previously, the email dictionary variable emailFrom returned the sender ID as xyz@aa.com.
Service Cloud case ID: 01856149

When you run a stored procedure in Oracle and it returns SYS_REFCURSOR, the Run stored
procedure action closes the cursors.
Previously, the Run stored procedure action was not closing the cursor after the maximum cursor
limit was reached.
Service Cloud case ID: 01842046, 01898572
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In the Active Directory пакет, when you perform a user account operation such as Add users
to group, Delete user, Disable user account, or Rename user, and if the username has an
asterisk (*), open parenthesis, or close parenthesis, you can now add a user without any error.
Previously, the username did not support the following special characters: asterisk (*), open
parenthesis, and close parentheses.
Service Cloud case ID: 01884962

When you create a folder in Outlook with a percentage (%) in its name (for example, Clients
%ClientA), create a бот using the Connect action from the Эл. почта пакет and then use the
Folder exists or Folder does not exist condition, the бот finds the Clients%ClientA and
retrieves mail from it.
Previously, the бот was not able to retrieve mails from the folder because percentage (%) was not
supported in the folder name.

When you connect to the Microsoft Access Database with JDBC and specify the database path, if
you use the following specific aggregation functions in the query, an error is no longer encountered
when you run the бот:

ASC, ATN, SQR, CBOOL, CCUR, CDATE,
CDBL, CDEC, CDATE, CDBL, CINT, CLONG, CLNG,
CSIGN, CSTR, CVAR, DATEADD, DATEDIFF, DATEPART,
DATESERIAL, DATEVALUE, FORMAT, IIF, INSTR, INSTRREV,
ISDATE, IsNull, ISNUMERIC, LEFT, LEFTS, LEN, MID,
MONTHNAME, DATE, NOW, NZ, SIGN, SPACE, STR, TIME, VAL,
WEEKDAYNAME, WEEKDAY, STRING, TIMESERIAL, CONCAT

When using the Task Bot: Run action, you can search dictionary and session variables to use as
input parameters. Previously, no results displayed when using this Advanced search feature.
Service Cloud case ID: 01879539

A TaskBot no longer fails when you debug or run it when any in_Window input variable is set.
Previously, in edit mode, when you debugged or ran a TaskBot with an input variable by selecting
the Use as input check box, the bot failed.
Service Cloud case ID: 01919263

When you use the Save action in the Эл. почта пакет, and if the email subject includes a comma
(,), the emails are saved successfully.
Previously, if the email subject included a comma (,) and you saved the email, the comma (,) was
replaced with an underscore (_).
Service Cloud case ID: 01786211

When you select the Package details page, and select the Availability tab, if the package (all
users or selected roles) is changed, then the Package details page displays the last modified
information of the user who made the changes, and the changes made at the access level (all users
or selected roles).

You can create боты using the Download file action of the Google Диск пакет.
Previously, when you used the Download file action and marked the Overwrite existing file
option to overwrite the file of the same name, the downloaded file became corrupted. If you then
used the Excel advanced > Open action to open this file, or manually tried to open the Excel file,
an error message displayed indicating that the Excel file was corrupted.
Service Cloud case ID: 01833815
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You no longer have an incorrect starting date when you create an event using the Google
Календарь пакет.
Previously, when you created an event in Google Календарь and entered the value in the Start
Date field with the event type set to All Day, the Google Календарь пакет decremented the day
value by one when you selected the All Day option.
Service Cloud case ID: 01815644

When you use the Excel advanced > Open action to open an Excel spreadsheet which did not
exist and then run the бот, the бот now displays the correct error message in Japanese.
Service Cloud case ID: 01857992, 01925567

You can successfully extract fields from a PDF file when you use the PDF > Extract field or
Extract text actions.
Service Cloud case ID: 01818304

When you use the 3.6.1-20220428-010115 version of the Имитация нажатия клавиш пакет to
enter keystrokes against specific webpages running in the Microsoft Edge browser with IE mode,
the бот processes the keystrokes faster.
Service Cloud case ID: 01820418

When you use the PDF > Split document action to split multiple PDFs into various folders and
then use the For each file in folder iterator to run the бот in a loop to split each file in the
specified folder, the бот no longer encounters an error.
Service Cloud case ID: 01803983

When you use the File > Copy Control Room file action and choose the dynamic file path option
to select a file from the Control Room repository, the бот no longer encounters an error. Previously,
even if the uploaded file was available in the Control Room, the бот failed and displayed this error
message: Get Resource failed: Error: Could not find the file at the Control
Room path. Check the file path and try again.
Service Cloud case ID: 01805364

When you use the File > Rename action to rename and overwrite an existing file, the бот no
longer shows an incorrect error message. Previously, when you tried to rename an existing file, the
бот showed an incorrect file name in the error message.
Service Cloud case ID: 01845943, 01858350

You can successfully rename the file and remove an extension from the file name by using the File
> Rename action. Previously, when used the Rename action to remove an extension from the file
name, the бот trimmed the last character from the file name instead.
Service Cloud case ID: 01842995

When you use the Средство записи to capture objects on an application that is installed on
a virtual machine, finish the recording after the objects are captured, and then relaunch the
Средство записи, the бот successfully launches the Средство записи and no longer inserts any
actions that were recorded earlier.

When you use the Recorder > Capture action to automate Citrix virtual apps running on Google
Chrome and Microsoft Edge browsers, add a delay of 60 seconds and run the бот, then if the
object does not exist, the бот waits for the specified time (60 seconds) in the Keep trying for
(seconds) field before executing the next steps.
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When you run the бот using the following sequence of actions, the бот shows accurate data for
each loop iteration:
1. Use the Database > Connect action to connect to the database
2. Use the Database > Read action to read the values from the database
3. Use the For each row in a SQL query dataset iterator to run the бот in a loop
4. Use the Database > Disconnect action to disconnect from the database and select the Keep

database schema in cache until bot finishes running option.

Previously, during the second loop iteration, the action picked up data from the previous loop.
Service Cloud case ID: 01817192, 01853717, 01880154, 01940546

An error no longer occurs when you use Средство записи пакет 2.8.6 and later versions to
perform a click operation on a link element that opens a pop-up window on a web page running in
Microsoft Edge with IE mode.
Service Cloud case ID: 01845776, 01858872, 01923003

When you install the AARemoteAgent_2.0, the DLL files are now copied to the correct A360
Remote Agent folder and the AARemoteAgent_2.0 runs properly. Previously when you installed
the AARemoteAgent_2.0, the DLL files were copied to an incorrect A360 Remote Agent\Java
folder.
Service Cloud case ID: 01935630

You can now successfully use the PDF > Extract field action to extract values from a PDF that
contains a string data type with the dollar sign ($).
Service Cloud case ID: 01848220

You can now successfully run all migrated web actions of the Legacy Automation пакет in multiple
steps of a бот in Microsoft Edge with IE mode.
Service Cloud case ID: 01853563, 01865846

In the File > Copy Desktop file action, when you use a variable that contains a number sign (#)
instead of a file path to locate the file that you want to copy, the бот no longer encounters an error.
Service Cloud case ID: 01808009, 01845923

When exporting data to Excel CSV files, Boolean values return accurately. Previously, a bug caused
values to return as -1 while using OLE DB Driver for SQL Server (version 18 or later).
Service Cloud case ID: 01826530

Updating the Bot Agent version sometimes failed. However, when you select the Automatically
update all bot agents option, the Bot Agent updates to the latest version without failures.

Control Room now supports Windows NT in French.
Service Cloud case ID: 00682337

All DELETE /v1/configurations endpoints are not accessible anymore.
Service Cloud case ID: 01920980

While installing Automation 360 on a three-node cluster, the installer prompts you to enter the
Elasticsearch password for the first node only and replicates this data across the other two nodes.
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Боты that are running for longer duration display correctly on the In progress activity page.
Previously, these боты displayed only after бот updates and were removed after the page refresh.
Service Cloud case ID: 01921149

You can now update Internet Explorer боты created in Automation 360 to Microsoft Edge with
IE mode using the Update Bot wizard even if these боты (or its dependencies) contain a
'.' (dot) character in its name.
Service Cloud case ID: 01809003, 01814904, 01822014, 01858820

If you selected the Log off windows session post bot execution option under Auto-login
settings in the Control Room, data in the resource folder is cleared after the бот run.
Service Cloud case ID: 01795752, 01778828, 01804711,01864871,01923299, 01823515

If you delete a device entry from Manage > Devices in the Control Room, the device registration
properties are removed. This enables you to reregister the device.
Service Cloud case ID: 01808450

You can successfully log in to Automation 360 using Active Directory credentials when the Auto-
login users into Control Room option is enabled, without encountering any issues..
Service Cloud case ID: 01808170, 01826805

The generated Control Room operational log files contain readable characters.
Service Cloud case ID: 01872473

The Repository Management (/v2/repository/files/<file_id>/content) API now returns file contents
only for the files the logged-in user has permission to view. The content of these files cannot be
updated using a different API.
Previously, this Repository Management API returned file contents for the files that the logged-in
user did not have permission to view. And the user could update the content of these files.
Service Cloud case ID: 01819101

Бот deployment now resumes and completes without any issue when the Task Bot > Pause
action executes before or while the runtime window is loading.
Previously, the resume option was not displayed in the runtime window, and the бот deployment
was not completed.
Service Cloud case ID: 01835794

You can create a folder within the Bots folder in the public workspace.
Previously, folder creation failed with an error in the public workspace.
Service Cloud case ID: 01257981

You can now successfully compare different versions of your боты and dependencies in both the
public and the private workspaces.
Previously, comparing the бот versions failed with a timeout error.
Service Cloud case ID: 01770115, 01905037
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When you export the user data to a CSV file, it now shows the correct user type and device license
information for all users.
Previously, user data exported to the CSV file showed incorrect information.
Service Cloud case ID: 01840507

You can now check in a бот successfully to the public workspace.
Previously, the бот check in failed because the audit trial was processed unsuccessfully.
Service Cloud case ID: 01860361

The BLM export is an asynchronous call and when used with the existing API endpoint /v2/blm/
status/{requestId}, there is a delay associated with the API call. Due to this delay, you cannot
retrieve the current status of the export if there is not enough time gap between the export and the
status call. To bypass this limitation, a new API endpoint has been added GET /v2/blm/status/
{requestId}/timeout/{timeout} which introduces a time delay that waits for the export
process to complete and then retrieves the status.
Service Cloud case ID: 01806109

Upgraded Swagger UI and Swagger Editor to version 4.15.5 to fix a security vulnerability.
Service Cloud case ID: 01843148

When you create боты that use the Excel advanced > Select cells/rows/column action and
set the Cell Range with an expression (such as B1:$SampleNumber.Number:toString$), the
Bot editor no longer displays an error and the action now works properly.
Service Cloud case ID: 01941537

When you use the File trigger to modify a BAT or VBS file, the trigger is generated once. Previously,
the trigger would generate twice when you enabled the file modified scenario.
Service Cloud case ID: 01816589, 01877498

You no longer encounter issues with bot check-in or cancel check-out after the bulk package update
operation. When you try multiple bulk updates of packages, now an appropriate error message
indicates to perform bulk updates of one package at a time.
Previously, when you performed multiple bulk updates of packages, it resulted in check-in or cancel
check-out errors.
Service Cloud case ID: 01849828, 01881950

Боты with a large number of automations complete successfully without any pre-processing issues
or errors.
Service Cloud case ID: 01949415, 01949372, 01949033

Исправления в системе безопасности

The version of Springframe Work is updated to 5.3.22 and does not exhibit the security
vulnerability. 
Service Cloud case ID: 01850811
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Ограничения

When you check out боты in bulk, you cannot check out the боты for which you have the required
permissions. This is because боты for which you have the required permissions are also excluded
along with the боты for which you do not have the required permissions.

The бот checkout fails in the following scenarios:
• If a бот with same name (but different case) exists in your private workspace with the same

path.

Прим.:  In such cases, the бот checkout or overwrite fails even when an overwrite confirmation
message displays.

• If a folder with the same name exists in your private workspace with the same path.

When you compare бот versions from the View history page in a Public workspace, the
Compare versions page shows an error message.
Обходное решение. To fix this error, perform one of the following actions:
• In a Public workspace, click the three dots icon next to the required бот in the Action menu

and click Compare versions.

Прим.:  You cannot compare the бот versions when only one бот version is available.

• If you check out a бот to a Private workspace and then modify and save it, click the three dots
icon in the Action menu and click Compare versions.

Service Cloud case ID: 01949094, 01946533

In Windows and Linux operating system, notifications are not working with the Oracle Database.

We use a third-party parser to convert from HTML format to plain text. As a result, when you
convert an email from HTML format to plain text, you will see that, sometimes, the text is not
converted into plain text and is not displayed in the correct format. For example, you might see that
some lines are added or skipped.
Service Cloud case ID: 01822614

In any пакет, when you select the Add argument option, select String or Number as the
Argument type, and then try to insert a value, you might not be able to navigate through the
options using the scroll functionality.

When you use the System > Get environment variable action to select the list of environment
variables to return the system parameters of the device, some environment variables might not be
visible.

After you upgrade to Automation 360 v.27, if a new пакет (first version) is added to the Control
Room and in the setting for пакеты you selected Disable for the new version of пакет, you will
see that the пакет will have status as Enabled and set as default instead of Disable.

In an Oracle Database environment, when you upgrade to Automation 360 v.27, the new пакет
versions that are shipped through the installer remain in the disabled state and are not set as the
default version.
Обходное решение. You must enable each updated or new пакет manually and set the пакет
as the default version.
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In the Automation page, column customizations made on the Files and folders are not retained
when you navigate away from that page. For example, if you customize the columns in the private
workspace, move out, and navigate back to the private workspace, the previous customization is
not retained. It returns to the default view.
Similarly, searches and customizations such as filters, sort orders, custom columns, and partially
completed edits are not retained when you navigate away from the page.

Ограничения из предыдущих выпусков

When you run a бот in the Google Chrome or Microsoft Edge browser, use the Если, Цикл, or
Ожидать action, select the webpage from the list of active tabs in the Browser tab, close the
browser window, and then run the бот, the бот might take two minutes to open the webpage in
the browser irrespective of the timeout value mentioned.
Обходное решение. Move the Если, Цикл, or Ожидать action inside the If block and use the
Application is running condition with same browser application to check whether the browser is
running.

You will encounter an error when you run a standard workflow in the SAP BAPI пакет.
Обходное решение. To execute SAP BAPI, use the Run Function call (RFC) with a combination
of Create function, Set or Get field value, Set or Get structure, and Set or Get table
actions.
A360 : SAP BAPI functions - Run Standard Workflow - Error while selecting
BAPI_SALESORDER_CHANGE (A-people login required)

When you migrate a бот that contains XML command > Get single node, after migration, the
бот encounters the following error: No node found at XPath while executing the Get
Single node commandWorkaround: If the XPath expression is not starting with (/) , apply
XPath starting with “/“ so that at the time of execution, the modification can be skipped or the
XPath expression can be designed to get the desired result.

When you use the Capture action with the Средство записи пакет (version 2.9.x or earlier) to
navigate to another web page in the Google Chrome browser (version 105.0 or later), and then use
another Capture action to automate objects in the navigated web page, the бот might encounter
an error.
Обходное решение. Before you use the Recorder > Capture action in the бот, maximize the
Google Chrome window .

When you use the Если пакет, add a specific condition with a variable, then add specific conditions
within a group, save the бот, and if you rename the variable that was used, the name of the
variable might not update for the Group conditions but is only updated for the conditions in the
Condition tab.

Command prompt API allows you to switch the device registration even if the Allow devices
(single user) to be switched to another Control Room without reinstalling bot agent
option is disabled.

When you upgrade from Automation 360 v.25 to a later version, although you enabled code
analysis in the Control Room, the rules set in the policy are not retained after the upgrade.
Обходное решение. Before upgrading, we recommend that you keep a note of the rules
enabled in Automation 360 v.25 and then re-enable them after upgrading to a later version.

When you uninstall Automation 360 from the Control Panel, the name of the file is displayed
incorrectly (for example, 3e592.msi) on the User Account Control window.
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Ограничения из предыдущих выпусков

While running a бот in debug mode, the бот will fail if the variable size gets greater than 3 MB. An
error message appears showing that a variable has exceeded the 3 MB limit.

Обновления в интерфейсе

Рабочая область RPA

The Max auto retry attempt option is added to reprocess the failed WLM work items
automatically.

Automated reprocessing of failed WLM work items
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Рабочая область RPA

The drop-down menu in the Bot editor now includes an option to open a menu for keyboard
shortcuts.

Keyboard shortcuts

The Device(s) from my device pools and Run as users default device(s) options are added
in the Edit the device(s) permission to manage registered and non-registered devices.

Better device management with improved device permissions
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Рабочая область RPA

The gMSA option enables you to manage your domain accounts across multiple

servers.
Manage domain accounts using gMSA
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Рабочая область RPA

The Custom number of bot runners option allows you to
choose the number of Bot Runner that you want to use to run

боты.
Customize the number of Bot Runners
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Рабочая область RPA

The Automation Anywhere Debugger tool is now available within the Bot Assistant utility to
provide a better user experience.

Enhanced Automation Anywhere Debugger tool

© 2023 Automation Anywhere. All rights reserved.     127



    Automation Anywhere - Learn

Рабочая область RPA

Updated and intuitive icons for all the actions and contextual help for Database and Email actions.

Enhanced user experience through intuitive icons | Quick assistance at hand for the developers in the Bot
editor
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Рабочая область RPA

The drop-down menu in the Bot editor now includes the Capture and run with admin
privileges option that enables you to capture objects on applications running in administrator
mode.

Capture objects in admin mode
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Ссылки, связанные с данной
Заметки о выпуске Automation 360 v.27
Обнаружение процессов v.27 release
Review what's new in Обнаружение процессов for the v.27 release.
AARI v.27 release
Review what's new and changed, and the fixes and limitations in AARI for the v.27 release.
IQ Bot and Document Automation v.27 release
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.27 release.
Bot Insight v.27 release
Review the fixes in Bot Insight for the v.27 release.
Пакеты updated in v.27
Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.
Updating to v.27 release
Review requirements and support information about updating your Control Room and Bot Agent for the
v.27 release.
Migration updates for v.27 release
Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10 versions
to Automation 360 v.27.
Browser extensions for Automation 360
Создавайте автоматизацию из поддерживаемых браузеров с помощью расширений браузера.
Расширения периодически обновляются для поддержки улучшений и исправлений функций.
Поэтому убедитесь, что у вас установлены последние версии расширений для браузеров Google
Chrome, Microsoft Edge и Mozilla Firefox.

Updating to v.27 release
Review requirements and support information about updating your Control Room and Bot Agent for the
v.27 release.

Обновления Bot Agent

Прим.:  Этот выпуск включает в себя необязательное обновление Bot Agent. You can continue to
run your existing боты without updating the Bot Agent. However, if you want to use the new features in
Automation 360 v.27, you must update the Bot Agent available with this release.

Более подробную информацию об обновлении до этого выпуска см. на указанных ниже ресурсах.
• Автоматическое обновление Bot Agent | Обновление Bot Agent вручную
• Compatibility with release builds

Certified Control Room builds for direct update

You can update to the latest version of Automation 360 from the previous three releases (that is, from n−3
releases, where n refers to the latest release).
The following previous releases are certified for update to Automation 360 v.27:
• v26 (Build 15450)
• v.25 (Build 15112)
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• v.24R2 (Build 13343) and v.24 (Build 12350)

If you are on one of these previous releases, for information about updating, see Обновление до
последней версии Automation 360. If you are not on an n−3 release, update Automation 360 to one of the
n−3 releases before updating to Automation 360 v.27.
Для получения информации о последних обновлениях до расширений Automation 360 для Google
Chrome, Microsoft Edge и Mozilla Firefox см. раздел Browser extensions for Automation 360.
Ссылки, связанные с данной
Заметки о выпуске Automation 360 v.27
Рабочая область RPA v.27 release
Review what's new and changed, and the fixes and limitations in Рабочая область RPA for the v.27
release.
Пакеты updated in v.27
Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.

Пакеты updated in v.27
Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.
The following table lists the updates in the пакеты for this release:

Прим.:  Информацию о пакетах, относящихся к предыдущим выпускам, см. в PDF-файлах для этих
выпусков: Предыдущие версии Automation 360.

Имя
Пакет
ВерсияОбновления
Пакет
Версия
Bot
Agent

Версия
Control
Room

AARI
web
7.27.0-20221026-170013Нет21.134
or
later

12316
or
later

Active
Directory
3.6.2-20221027-064844• New

feature
• Defect

fix

20.11
or
later

8750
or
later

Analyze2.4.4-20220615-020937Нет20.11
or
later

8750
or
later

Интеграция
приложений
4.8.0-20220616-123118Нет21.88
or
later

10195
or
later

Приложение3.6.1-20221014-042725Localization
changes
20.11
or
later

8750
or
later
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Имя
Пакет
ВерсияОбновления
Пакет
Версия
Bot
Agent

Версия
Control
Room

Логический2.6.4-20220919-050851Internal
renaming
of
an
attribute
(no
impact
to
existing
боты
on
upgrade)

20.11
or
later

8750
or
later

Миграция
Бот
10.3.4-20221020-152650• New

feature
1

• New
feature
2

• New
feature
3

• Defect
fix
1

• Defect
fix
2

• Defect
fix
3

• Defect
fix
4

• Defect
fix
5

21.220
or
later

15224
or
later

Браузер3.7.5-20221104-153650New
feature
21.210
or
later

14140
or
later

Буфер
обмена
3.5.0-20220923-115005Localization
changes
20.11
or
later

8750
or
later
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Имя
Пакет
ВерсияОбновления
Пакет
Версия
Bot
Agent

Версия
Control
Room

Комментарий2.12.0Internal
renaming
of
an
attribute
(no
impact
to
existing
боты
on
upgrade)

20.11
or
later

8750
or
later

Credential1.4.0-20220930-120805Enhancement20.11
or
later

8750
or
later

CSV/
TXT
2.10.2-20221025-092104Added
intuitive
package
icon

20.11
or
later

8750
or
later

База
данных
4.10.5-20221119-112148• New

feature
1

• New
feature
2

• Defect
fix
1

• Defect
fix
2

• Defect
fix
3

21.88
or
later

10204
or
later

Таблица
данных
4.6.0-20220920-155212Internal
renaming
of
an
attribute
(no
impact
to
existing
боты
on
upgrade)

20.11
or
later

8750
or
later
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Имя
Пакет
ВерсияОбновления
Пакет
Версия
Bot
Agent

Версия
Control
Room

Дата/время2.10.3-20220919-051216New
feature
20.11
or
later

8750
or
later

Задержка3.6.0-20220926-132853Internal
renaming
of
an
attribute
(no
impact
to
existing
боты
on
upgrade)

20.11
or
later

8750
or
later

Словарь3.10.0-20220929-153817Defect
fix
20.11
or
later

8750
or
later

DLL6.7.1-20221027-124401New
feature
21.220
or
later

15238
or
later

Document
Extraction
1.9.0-20221223-075522Fixes21.98
or
later

15345
or
later

Эл.
почта
3.15.2-20221006-075826• New

feature
1

• New
feature
2

• New
feature
3

• Defect
fix
1

• Defect
fix
2

• Defect
fix
3

21.210
or
later

13980
or
later

Триггер
эл.
почты

2.9.1-20221006-095506New
feature
21.210
or
later

13980
or
later
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Имя
Пакет
ВерсияОбновления
Пакет
Версия
Bot
Agent

Версия
Control
Room

Обработчик
ошибок
2.10.0-20220929-040735Internal
renaming
of
an
attribute
(no
impact
to
existing
боты
on
upgrade)

20.11
or
later

8750
or
later

Расширенный
Excel
6.11.0-20220919-135308Defect
fix
21.112
or
later

11307
or
later

Базовый
Excel
6.11.0-20220919-135307Added
intuitive
package
icon

21.112
or
later

11307
or
later

Файл6.5.0-20221003-160340• Defect
fix
1

• Defect
fix
2

• Defect
fix
3

21.98
or
later

10789
or
later

Файл
и
папка

1.3.0-20221014-182105Defect
fix
20.11
or
later

8750
or
later

Папка6.5.0-20221003-160340Added
intuitive
package
icon

20.11
or
later

8750
or
later

FTP /
SFTP
2.8.3-20221006-182804Localization
changes
20.11
or
later

8750
or
later

Genesys1.0.4Нет21.210
or
later

14199
or
later

Google
Календарь
2.9.1-20221006-143939Defect
fix
20.11
or
later

8750
or
later
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Имя
Пакет
ВерсияОбновления
Пакет
Версия
Bot
Agent

Версия
Control
Room

Google
Диск
2.10.1-20221006-142241Defect
fix
20.11
or
later

8750
or
later

Google
Document
AI

1.2.0-20220616-091303Fixed
the
vulnerabilities
reported
in
the
security
scan

21.98
or
later

10520
or
later
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Имя
Пакет
ВерсияОбновления
Пакет
Версия
Bot
Agent

Версия
Control
Room

Google
Таблицы
2.10.1-20221006-123001The
error
is
no
longer
displayed
when
you:
• Create

a
sheet
with
the
existing
sheet
name.

• Use
Delete
cell
>
Specific
cell
and
select
the
delete
option
as
Shift
cell
left.

• Open
the
spreadsheet
with
session
2
after
disconnecting
the
session
1.

• An
appropriate
error
message
displays
when
you
disconnect
an
previously
closed
session.

20.11
or
later

8750
or
later
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Имя
Пакет
ВерсияОбновления
Пакет
Версия
Bot
Agent

Версия
Control
Room

Google
G
Suite

2.8.0-20220416-235104Нет20.11
or
later

8750
or
later

Hot
key
1.1.0-20220715-220729НетНетНет

Если3.5.0-20220928-201537Internal
renaming
of
an
attribute
(no
impact
to
existing
боты
on
upgrade)

20.11
or
later

8750
or
later

Распознавание
изображений
3.11.1-20221025-190453Fixed
the
vulnerabilities
reported
in
the
security
scan

21.210
or
later

14100
or
later

Интерактивные
формы
2.27.3-20221014-074409• New

feature
1

• New
feature
2

• New
feature
3

• New
feature
4

• New
feature
5

20.11
or
later

8750
or
later

Interface
trigger
1.5.1-20221122-181213None.20.11
or
later

8750
or
later

© 2023 Automation Anywhere. All rights reserved.     138



    Automation Anywhere - Learn

Имя
Пакет
ВерсияОбновления
Пакет
Версия
Bot
Agent

Версия
Control
Room

IQ
Bot
2.2.5-20221107-102303Fixed
the
vulnerabilities
reported
in
the
security
scan

21.98
or
later

10520
or
later

IQ
Bot
Pre-
processor

2.2.5-20221107-101937Fixed
the
vulnerabilities
reported
in
the
security
scan

21.98
or
later

10520
or
later

JavaScript2.13.0-20220620-094839Нет20.11
or
later

8750
or
later

JSON1.2.0-20221003-172422Internal
renaming
of
an
attribute
(no
impact
to
existing
боты
on
upgrade)

21.98
or
later

10520
or
later

Legacy
AISense
2.0.1-20221019-100134Defect
fix
21.220
or
later

15224
or
later

Legacy
Automation
5.6.1-20221027-080331• New

feature
• Defect

fix

21.200
or
later

13279
or
later
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Имя
Пакет
ВерсияОбновления
Пакет
Версия
Bot
Agent

Версия
Control
Room

Список2.9.2-20220919-103920Internal
renaming
of
an
attribute
(no
impact
to
existing
боты
on
upgrade)

20.11
or
later

8750
or
later

Записать
в
файл

3.5.0-20220416-233918Нет20.11
or
later

8750
or
later

Цикл3.6.0-20220928-191723Internal
renaming
of
an
attribute
(no
impact
to
existing
боты
on
upgrade)

20.11
or
later

8750
or
later

Message
Box
3.4.0-20220416-233919Нет20.11
or
later

8750
or
later

Мышь2.12.4-20221021-043050Fixed
the
vulnerabilities
reported
in
the
security
scan

21.210
or
later

14100
or
later

Число3.6.0-20220928-104414Added
intuitive
package
icon

20.18
or
later

9130
or
later

Распознавание
текста
(OCR)

2.10.0-20220502-204318Нет21.118
or
later

8750
or
later
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Имя
Пакет
ВерсияОбновления
Пакет
Версия
Bot
Agent

Версия
Control
Room

Календарь
Office
365

2.10.1-20221006-064900Added
intuitive
package
icon

20.11
or
later

8750
or
later

Office
365
Excel

2.10.1-20221006-064900Added
intuitive
package
icon

20.11
or
later

8750
or
later

Office
365
OneDrive

2.10.1-20221006-064900Defect
fix
20.11
or
later

8750
or
later

PDF3.7.1-20221012-090203• Defect
fix
1

• Defect
fix
2

21.31or
later
9300
or
later

PGP3.4.0-20220118-154220Нет21.88
or
later

10195
or
later

Ping3.4.0-20220416-234250Нет20.11
or
later

8750
or
later

Воспроизвести
звук
2.6.0-20220421-071315Нет20.11
or
later

8750
or
later

Принтер2.4.0-20220118-154256Нет20.11
or
later

8750
or
later

Триггер
процесса
1.3.0-20220118-154818Нет21.112
or
later

11314
or
later

Обнаружение
процессов
2.1.14-20221024-185703Нет21.128
or
later

12247
or
later

Запрос2.6.0-20220118-154257Нет20.11
or
later

8750
or
later
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Имя
Пакет
ВерсияОбновления
Пакет
Версия
Bot
Agent

Версия
Control
Room

Python
Script
2.13.0-20221101-070548Fixed
the
vulnerabilities
reported
in
the
security
scan

20.11
or
later

8750
or
later

Запись1.6.3-20220919-051027Internal
renaming
of
an
attribute
(no
impact
to
existing
боты
on
upgrade)

20.11
or
later

8750
or
later

Средство
записи
2.9.2-20221122-181034• New

feature
1

• New
feature
2

• Defect
fix

21.210
or
later

14068
or
later

Веб-служба
REST
3.12.0-20220926-070217Fixed
an
issue
where
different
proxies
were
configured
for
a
URL
using
a
PAC
file.

20.11
or
later

8750
or
later

Salesforce1.4.0-20220921-170743Нет21.119
or
later

15422
or
later
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Имя
Пакет
ВерсияОбновления
Пакет
Версия
Bot
Agent

Версия
Control
Room

SAP3.8.1-20221021-121957Added
intuitive
package
icon

21.88
or
later

10195
or
later

SAP
BAPI
2.7.0-20220424-053247Нет21.2
or
later

9249
or
later

Экран2.8.0-20220426-033753Нет20.11
or
later

8750
or
later

Служба4.6.0-20220930-121118Localization
changes
20.11
or
later

8750
or
later

Триггер
службы
1.5.1-20220425-083711Нет21.112
or
later

11314
or
later

ServiceNow1.3.0-20221010-154249New
feature
21.230
or
later

16455
or
later

Имитация
нажатия
клавиш

4.1.0-20221021-090235• New
feature

• Defect
fix

21.200
or
later

13297
or
later

SNMP2.5.0-20220419-063009Нет20.11
or
later

8750
or
later

Веб-служба
SOAP
3.13.1-20221025-092212Label
change
(Build
Soap
Request
is
renamed
to
Build
SOAP
request)

21.90
or
later

10227
or
later
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Имя
Пакет
ВерсияОбновления
Пакет
Версия
Bot
Agent

Версия
Control
Room

Шаг2.4.0-20220929-044740Internal
renaming
of
an
attribute
(no
impact
to
existing
боты
on
upgrade)

20.11
or
later

8750
or
later

Строка5.5.2-20221006-094641New
feature
20.18
or
later

9130
or
later

Система3.10.0-20220921-062556Internal
renaming
of
an
attribute
(no
impact
to
existing
боты
on
upgrade)

21.88
or
later

10217
or
later

TaskBot2.5.0-20221020-114450Updated
the
version
for
botRunTime
and
bot
 API

20.11
or
later

8750
or
later

Эмулятор
терминала
4.8.0-20220923-172123New
feature
21.93
or
later

10353
or
later

Текстовый
файл
1.4.2-20221004-130231New
feature
20.11
or
later

8750
or
later

Триггерный
цикл
0.7.0-20220715-220725Нет20.11
or
later

8750
or
later

TaskBot V111.12.1-20220707-062607Defect
fix
20.11
or
later

8750
or
later
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Имя
Пакет
ВерсияОбновления
Пакет
Версия
Bot
Agent

Версия
Control
Room

VBScript2.16.2-20221020-051711Fixed
the
vulnerabilities
reported
in
the
security
scan

21.210
or
later

14100
or
later

Ожидать4.7.0-20221003-160840Internal
renaming
of
an
attribute
(no
impact
to
existing
боты
on
upgrade)

20.11
or
later

8750
or
later

Окно5.8.0-20220923-081314Added
intuitive
package
icon

20.11
or
later

8750
or
later

Триггер
Окно
1.4.0-20220118-154823Нет20.11
or
later

11314
or
later

Рабочая
нагрузка
2.10.1-20220512-164301Нет20.11
or
later

8750
or
later

XML3.8.2-20221025-092212Defect
fix
20.11
or
later

8750
or
later

*These fixes are minor, internal updates, so they do not include an update or further details on our documentation
site. As these updates relate to improvements in security, resiliency, and efficiency, we recommend that you use the
latest package versions to include these updates in your existing bots.

Ссылки, связанные с данной
Updating to v.27 release
Review requirements and support information about updating your Control Room and Bot Agent for the
v.27 release.
Рабочая область RPA v.27 release
Review what's new and changed, and the fixes and limitations in Рабочая область RPA for the v.27
release.
Заметки о выпуске Automation 360 v.27
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Migration updates for v.27 release
Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10 versions
to Automation 360 v.27.

Новые возможности

Enterprise 11 и Enterprise 10

Scan Automation 360 боты that use Basic authentication in Эл. почта action
This release introduces an option to use the Bot Scanner to scan all Automation 360 боты and
identifies those that use Basic authentication in the Эл. почта пакет and Email trigger action so
that you do not have to identify them manually.
You can use the Bot Scanner report to analyze the impact to the боты due to the Basic
authentication and the estimated effort required to switch the authentication mode from Basic to
OAuth 2.0.
Для получения дополнительной информации см. Scan Automation 360 боты for Эл. почта action
with Basic authentication usage | Basic authentication scanning messages.

Переменные, созданные автоматически после миграции
In the Bot Scanner utility, боты that contain the following non-referenced system variables are no
longer flagged as Action Required or Review Required:
• $Excel Column$
• $Filedata Column$
• $Dataset Column$
• $Table Column$
• $XML Data Node$
• $PDFTitle$
• $PDFSubject$
• $PDFFileName$
• $PDFAuthor$

After migration, the system automatically creates these variables based on the Automation 360
naming convention, and the migrated боты run successfully.

Support for SMTP server type with Отправить сообщение эл. почты command
When you migrate боты with the Отправить сообщение эл. почты command, you can select the
Use outgoing Email server settings option in the Bot Migration Wizard to identify and select the
server type for the Enterprise 11 боты. You can configure required server details using a new SMTP
server type option.
См. раздел Миграция корпоративных боты.
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Enterprise 11 и Enterprise 10

Improved automated editing ability for legacy боты
When you migrated legacy боты that contained the Записать в файл command, the Carriage
Return and Line Feed (CRLF) characters were converted to LF characters automatically. In
Automation 360, the text is displayed in a single line with no line feed, whereas in Enterprise
11, the CRLF is added at the end of each line as a line feed. As a result, you had to add the
$String:Newline$ variable to insert a CRLF in the migrated бот.
The new Convert \n characters to \rn\n Log to File action option in the Bot Migration Wizard
enables you to add a new CRLF automatically to migrated боты and avoid manual edits. Migrated
боты that use the Записать в файл sub-commands to log files can use the CRLF characters in a
string.
См. Миграция корпоративных боты
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Enterprise 11 only

Migration enhancement to packages and actions
• When you migrate Enterprise 11 боты with variables whose values are read from a text file, the

system adds the String: Import string from text file subcommand to import the variables
from the text file into a string variable. As a result, extra lines are added in the migrated боты.
The Read variables action has been added in the Текстовый файлpackage to address the
extra lines.
You can use this action to read the values of all variables in a text file as a single line in a
migrated бот which simplifies the post-migration efforts and reduces the number of lines added
in a migrated бот.
См. Read variables action

• Microsoft is removing the capability to use Basic authentication in Exchange Online for the
following protocols:
• RPC
• MAPI
• Offline Address Book (OAB)
• Exchange Web Services (EWS)
• POP
• IMAP
• Exchange ActiveSync (EAS)
• PowerShell

For those customers running бот for Эл. почта automation that connect to Exchange Online
using the IMAP, POP3, or EWS protocol with Basic authentication, we have added authentication
options to support OAuth2 authentication.
You can migrate Enterprise 11 ботыwith the authentication type set to the OAuth2 option with
Authorization code with PKCE or Client credentials.

• In the Read from action of the База данных пакет, the following option is introduced: Don’t
create file if no data is found. This option is selected by default for migrated боты with the
База данных пакет, and the migrated боты now follow the same behavior as Enterprise 11. If
the executed SQL query does not return any data, the behavior is as follows:
• If this option is selected, no CSV file is created.
• If this option is not selected, a 0 KB CSV file is created.

Подробнее см. в разделе Using the Read from action.
• Migrated боты support the newly added Return key in the Simulate Keystrokes >

Keystrokes action. These боты will continue to display the Enter key (which has been
renamed to Num Enter) and the newly added Return key.

• Migrated боты support access to the Datetime global variable across all actions in the
Дата/время commands.

You can successfully migrate TaskBots that contain references to multiple MetaBots which include
DLLs with same name. The session name of the first DLL is created using the name of the DLL.
When the subsequent DLL with the same name from another MetaBot is migrated, the ID of the
folder in which the DLL resides is used as a session name.
For example: M_DLL_Session-<MetabotFolderId>_<DLLName>.

© 2023 Automation Anywhere. All rights reserved.     148



    Automation Anywhere - Learn

Исправления

If the Enterprise 11 боты used the Отправить сообщение эл. почты command without configuring
authentication, now after migration the Email server host, Email server port, and My server
requires authentication values are set to the appropriate values.
Previously, after migration, these values were set to null variables and authentication failed.
Service Cloud case ID: 01849475

After migration, боты that are using Visual Basic script or JavaScript in the Run Script legacy
automation action and using multiple parameters that include spaces without quotation marks will
now display the correct output after execution.
Previously, such боты were displaying incorrect output.
Service Cloud case ID: 01901882

An error no longer occurs during migration when the Select Query бот runs validation. Previously,
the following error randomly occurred with text drivers.
[Microsoft][ODBC Text Driver] Object invalid or no longer set.

After migrating to Automation 360, if the Application window does not exist for the боты that use
the Если, IF/ELSE, or Цикл in Windows control, then these боты no longer encounter errors during
бот run.
Service Cloud case ID: 01846262

The Stored Procedure parameters are set correctly with Nvarchar when you migrate боты to
Automation 360.

When a бот that contained the File and Folder loop was migrated to Automation 360, an error
was displayed if the corresponding folder did not exist. You can migrate such боты like the
corresponding legacy бот as the If condition is now added before the File and Folder loop to
check if the folder exists.

You can migrate боты that contain the Substring command from the Строка пакет to Automation
360, even if the optional Length attribute is blank.

When you migrate a бот that has $counter variable within a nested loop to Automation 360, the
child loop counter is now set to the parent loop counter and the child loop iteration is processed
correctly.

When you run a Select query inside a Цикл package, and you reiterate its result set further, the
resultant Loop now reiterates the latest record as expected.
Service Cloud case ID: 01799961

You can successfully migrate боты that have the Wait for object to exist value option set to 0
seconds in the Object Cloning command.

When you use the Run Logic command with an IF/ELSE condition that uses a Credential
variable, all credential variables migrate successfully.

When you migrate Enterprise 11 боты with string variables that have static values, variable parsing
through legacy expressions is no longer performed. This avoids unnecessary parse expressions from
being added to the migrated боты.
Service Cloud case ID: 01819830
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You can successfully run migrated боты that contain multiple Буфер обмена variables as an output.
Automation 360 adds the Clipboard:Copy to action after every variable so that migrated бот is
run properly.
Service Cloud case ID: 01815938

When you migrate Enterprise 11 боты that use the Connect action with the Эмулятор терминала
command, and if the Hostname field contains a Credential Variable, then the field is mapped
correctly after migration.
Service Cloud case ID: 01861600

When you run migrated боты that contain the Legacy Automation > Manage web controls >
Select Item by Text action, the list that contains variables is now displayed as expected.
Service Cloud case ID: 01782998

You can now change, reallocate, or delete the license of a Bot Runner user in a migrated
Automation 360 Control Room, even if the Bot Runner user had logged in to Enterprise 11 Client at
least once.
Previously, an error was displayed in such cases.
Service Cloud case ID: 01829547

You can run migrated боты successfully on SMTP servers when you include the Отправить
сообщение эл. почты command inside a Цикл, and that loop iterates more than 100 times.
Service Cloud case ID: 01792886

Migrated боты do not create duplicate variables when the Error_description variable is case-
sensitive.
Service Cloud case ID: 01861530

You can now successfully migrate audit logs using the audit log export utility on a multi-node setup
from the Enterprise 11 Control Room.
Previously, the audit log export utility displayed an exception error in such cases and the audit logs
could not be migrated.
Service Cloud case ID: 01912835

Ограничения

In Enterprise 11, if боты were using certain keys (such as: Ctrl, Shift, Caps Lock, Num Lock, and so
on) in the Insert Keystrokes command, the keys were reset when an error was encountered during
the execution of child боты. However; after migration, these keys are not reset when an error is
encountered during the execution of child боты. As a result, different output or behavior might
occur during the execution of the other subsequent child боты or the main бот.
Service Cloud case ID: 00773679
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When you migrate a бот that uses the Send email command and run the бот in Automation 360,
the predefined placeholders in the email body are not replaced with their actual content.
Пример.

Task Name: <taskname>
Repeat: <repeat>
Status: <status>
Last Run Time: <lastruntime>

Whereas when you run the бот in Enterprise 11 with these placeholders, the following output is
generated:

Task Name: PLACEHOLDER_SEND.atmx
Repeat: Do not Repeat
Status: Failed
Last Run Time: 11/29/2022 13:04:22

Service Cloud case ID: 01908010

When you run a migrated бот with an XML package that contains an Xpath expression, the
running бот might fail and generate this error message: No node found at XPath
This issue might occur for these specific scenarios:
• If the root element does not have a namespace, and the child element of the XML package has

a default namespace.
• If there are more than one xmlns (the default XML namespace) defined in the XML document.

Service Cloud case ID: 01874203, 01798339
См. XML path is not working which works fine in Enterprise 11

Обновления в интерфейсе
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Миграция

The Bots using Email action with Basic authentication option is added to the Bot
Scanner to scan боты that use basic authentication in the Эл. почта package and Email

trigger.
Scan Automation 360 bots that use Basic authentication in Email action
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Миграция

The Use outgoing Email server settings option is added to the
Bot Migration Wizard to specify the type of email server you use.

Support for SMTP server type with Отправить сообщение эл. почты command
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Миграция

The Convert \n characters to \rn\n Log to File action option is
added to the Bot Migration Wizard to provide you an option to not have to
edit the боты manually and a new line is added automatically in migrated

боты.
Improved automated editing ability for legacy bots

Ссылки, связанные с данной
Заметки о выпуске Automation 360 v.27
Рабочая область RPA v.27 release
Review what's new and changed, and the fixes and limitations in Рабочая область RPA for the v.27
release.
Updating to v.27 release
Review requirements and support information about updating your Control Room and Bot Agent for the
v.27 release.

Remote agent v.2.1.0 updates
A new version of the Remote agent is released with Automation 360v.27. This section includes the fixes for
Remote agent version 2.1.0.
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Исправления

When a бот keeps running for a few hours, an error no longer occurs due to high memory usage
with the Средство записи package version 2.9.2 or later.
Previously, an increase in memory usage caused the бот to fail after a few hours with a Java
heap space error.
Service Cloud case ID: 01911565

An error no longer occurs when you use Средство записи пакет 2.8.6 and later versions to
perform a click operation on a link element that opens a pop-up window on a web page running in
Microsoft Edge with IE mode.
Service Cloud case ID: 01845776, 01858872, 01923003

When you install the AARemoteAgent_2.0, the DLL files are now copied to the correct A360
Remote Agent folder and the AARemoteAgent_2.0 runs properly. Previously when you installed
the AARemoteAgent_2.0, the DLL files were copied to an incorrect A360 Remote Agent\Java
folder.
Service Cloud case ID: 01935630

In the Средство записи пакет, you can now use the Left click, Right click, and Set Text with
delay actions for cross-domain IFrames to automate web pages on Google Chrome and Microsoft
Edge browsers with Manifest V3 extensions. Previously, these actions were not working for cross-
domain IFrames with Manifest V3 extensions.

In the Средство записи пакет, you can now use the Click action for the Link and Form tag
controls that have inline scripting with JavaScript using Manifest V3 extensions.

When you use the Recorder > Capture action to automate Citrix virtual apps running on Google
Chrome and Microsoft Edge browsers, add a delay of 60 seconds and run the бот, then if the
object does not exist, the бот waits for the specified time (60 seconds) in the Keep trying for
(seconds) field before executing the next steps.

Обнаружение процессов v.27 release
Review what's new in Обнаружение процессов for the v.27 release.

Новые возможности

PEG Serverless
With support of up to 100 simultaneous sensors, businesses can easily redact sensitive data
at scale before the data is sent to the Обнаружение процессов platform. Businesses can run
Обнаружение процессов data collection across multiple teams simultaneously, while still providing
one interface for IT Admins to manage the configuration, and one interface for the business to
review the redactions.
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PEG Configuration UI
IT Admins can easily manage forwarding configurations, redaction configurations, and export logs
from a web UI instead of having to run commands on the command line.
Manage redaction and forwarding settings from the UI

Исправления

Discovery Bot admins can now view all created processes without having the Discovery Bot recorder
license.
Previously, if a Discovery Bot admin did not have a Discovery Bot recorder license and was using
version A360.24, A360.25, or A360.26, all created processes did not display on the Processes page.
Service Cloud case ID: 01859123, 01877311, 01860901

Ссылки, связанные с данной
Заметки о выпуске Automation 360 v.27
Рабочая область RPA v.27 release
Review what's new and changed, and the fixes and limitations in Рабочая область RPA for the v.27
release.
AARI v.27 release
Review what's new and changed, and the fixes and limitations in AARI for the v.27 release.
IQ Bot and Document Automation v.27 release
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.27 release.
Bot Insight v.27 release
Review the fixes in Bot Insight for the v.27 release.
Пакеты updated in v.27
Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.

AARI v.27 release
Review what's new and changed, and the fixes and limitations in AARI for the v.27 release.
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Новые возможности

Smart embedded forms and dynamic data mapping for embedded widgets
You can now design your forms using a responsive and real-time canvas that can automatically
adjust to the desired form size. This enables a faster way for you to create an embedded interface
for use in any web application. You can also use these forms in your business applications to
securely retrieve data when embedded as an iFrame widget.
To save time and eliminate data re-entry, you can use the postMessage API to map and pre-
populate data from business applications in embedded widgets. Dynamic data mapping provides a
safe and secure communication from your business (host) applications to the initial process forms in
the widget.
Smart embedded forms and dynamic data mapping

Build forms easily by dragging elements to form builder
You can now build your forms by just dragging your elements to a blank form builder. As you add
elements to the form builder, it automatically adjusts without your input, letting you focus on the
form-building experience. You can also re-size the columns of your elements.
Create a form

Map data in host web applications for AARI Integrations
You can now map your host applications data to your AARI forms so that when you create a
request, the initial form field will be automatically populated with the mapped data.
Map host data to process

URL parameters support for iFrame widget
You can use URL parameters to pass data types (date, time, number, and text box) through query
parameters for your initial forms in the iFrame widget. Because the iFrame URL allows you to
modify the URL to add data types, you can now directly populate data from a host application for
form elements without having to keep re-entering the data.
Deploy automations in web application | Параметры URL-адреса

Virtual window support for iFrame widget
You can now run your боты in a virtual window (picture-in-picture view) for AARI Integrations.
With this option, you can run an attended бот in a small virtual window on your screen (instead of
another desktop page or application) simultaneously while you complete tasks on the same page
without obstructing your automation experience.
Deploy automations in web application | Configure an AARI bot

Select tags in widget setup
When you configure your widget in the Integrations page, the Filter automations option allows
for you to select existing tags that can be added to your widget. You can now reference tags with
the corresponding widgets in the widgets tab for easier reference in the tags column.
Setup iFrame widget using AARI Integrations
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View status and run time details in automation list
You can now view the status and run time of your боты and processes in the automation list. The
status and run time are based on your боты and processes last activities. You can quickly review
whether a бот was completed in x amount of days or time ago, or shows no activity at all.
Deploy automations in web application

AARI shortcut link
You can now access AARI directly from your Рабочая область RPA. The Explore AARI link in the
new AARI tab from the homepage is a shortcut that redirects you to the AARI portal. This is an
easier way for you to access AARI if you forget how to access AARI or need to modify the URL to
access AARI.

Развернуть процессы

New actions in the Process Composer
In the Process Composer, you can now use a set of actions when you build out your process. For
example, you can double-click a task, such as Bot Task and Human Task, and the task will be
updated in your process flow automatically. With this, you can save time because you do not need
to task specific tasks to your process. In addition, you can now copy, cut, and paste using CTRL +
C, CTRL + X and CTRL + V, respectively to retain, reuse, or replace data.
Behaviors supported in the Process Composer | Создание процесса AARI

Use a reference ID meta type in Process Composer
You can now use a reference ID with a Meta variable type for your variables in the Process
Composer. When you set a reference ID as a meta variable type, you can now use your reference
ID data when you run your tasks in the web interface. This simplifies your references because you
only need to rely on using the reference ID instead of relying on other variable types or references.

Создание процесса AARI

Center your forms in preview
You can now preview your forms in the new preview window and get an accurate assessment on
how your form will look when it is rendered. You can select the Make form preview centered
option to enable the preview window. You can also set the appropriate display resolution, x and y
coordinates, and even center your form.
Create a form

Upload images directly to the form composer
You can now upload images directly to the form composer by using the Image element. This saves
you time to view the images in the form without a file reference, rather than in the initial step,
where the image requires a file reference to be viewed.

Прим.:  Image files are limited to 150 kb (like a logo).

Using the Image element

Change label action for Button element
The change label action in the form rules now applies to the Button element. When you use the
change label action in form rules and apply it to the buttons in your form, the changes will be
automatically applied to the buttons where you set the rules. This keeps the flow consistent with
the elements that you are using because all the buttons inherit the same rule.

Добавление правил к элементам формы
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Rules editor for Table element
The rules editor is now applicable to the Table element. When you use the rules editor for your
tables, the rules conditions are applied for each individual columns while any actions that you set
are applied for each row in the row level. This makes things consistent for each new or existing row
that you use because all the rows inherit the same rule.

Добавление правил к элементам формы

Изменения

Build 16701: This build includes the following enhancement:

Enhanced automation experience in AARI Assistant
We have improved the automation experience for your automation activities in AARI Assistant.
• You must have the Manage my activity permission as a prerequisite to use the бот controls.
• When you run your automation, the бот, its progress page, controls for pause, start (resume),

and stop, are all unified inside AARI Assistant. Previously, there was a seperate window for
the bot run and its controls. (This will still be seen in this version but will be hidden in future
releases.)

• You can view the status of your бот progress and its details, and is reflected on the activity
page.

• You can view and manage pending automation that have been initiated and users can navigate
between bot list view and progress view. If you have multiple AARI Assistant instances or
disconnect and then reconnect to a different instance, the pending automation will be visible
from the progress page for you to control.

Service Cloud case ID: 01793119, 1815462
AARI Assistant automation activities

Build 16667: This build includes the following enhancements:

Define tags in process configuration
When you edit a process, you can use the Tags field to search and specify tags based on
keywords, to define your process. You can add tags from new or existing tags and use them to
reference specific tags related to your process.
Configure an AARI process

Исправления

Build 16701: This build includes the following fixes (along with fixes from the previous builds):
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In AARI Assistant, you can continue your pending automation in different AARI Assistant instances.
Automations are no longer stuck, and you can run боты as usual.
Service Cloud case ID: 01829572

Прим.:  This fix was first included with Build 16694 for Cloud Sandbox and Community Edition.
Сборка 16701 now includes this fix for Cloud, Cloud Sandbox, and Community Edition.

Build 16685: This build includes the following fixes (along with fixes from the previous builds):

When боты have a file dependency or an interactive form that includes any multibyte character
in its name, the боты run as expected. Previously, having the multibyte character in a form name
caused an error.
Service Cloud case ID: 01947340

Build 16667: This build includes the following fixes:

You can now view signatures when you preview files using the AARI document viewer. Previously,
signatures could be viewed only when files were opened in a separate tab.
Service Cloud case ID: 01879533

Боты are no longer triggered when you modify a file in an authenticated network. Previously, bots
would trigger when you modified a бот in a network that required authentication.
Service Cloud case ID: 01256344, 01756709, 01854164, 01888188

The resiliency of the Create > Request action has improved in the Process package.
Service Cloud case ID: 01886231

You can add, delete, and change values to the column cells when you create forms using the
Column Filter function. Previously, an error altered the accuracy of this operation by sometimes
changing rows or filtering newly edited values.
Service Cloud case ID: 01854490, 01941416

When scrolling past 100 task боты in AARI Assistant page, fresh боты now load to successfully
complete the list of боты not yet displayed.
Service Cloud case ID: 01804139, 01845208, 01881927

You can select Reference ID as a Meta variable type from the Variable drop-down list.
Service Cloud case ID: 01861551

When you enter data in a password field in the initial form, the password field retains your data
after you submit the form without requiring you to re-enter the data.
Service Cloud case ID: 01846222

When you use a file element to select multiple files, the file element functions properly without
having to reset the form.
Service Cloud case ID: 01840888
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Buttons in forms work as expected. Previously, some users encountered an exception error and
were unable to click Confirm to submit their form.
Service Cloud case ID: 01846856

When you run a bot in AARI, you can edit the auto-populated fields after you select an option from
the drop-down menu.
Service Cloud case ID: 01853623

When you use a number element and enable the Use comma to separate thousands format
option, the бот will run without issues. Previously, some users encountered an exception error.
Service Cloud case ID: 01869566

When you use the File modified trigger option to modify the contents or files, the trigger works
properly.
Service Cloud case ID: 01812596

When you use a document element in your form to upload PDF files, the PDF files that are
uploaded renders the contents properly.
Service Cloud case ID: 01802898, 01833266

Known Limitations

Image files uploaded to forms for access in the Process Composer are limited to 150 kb.
Example of uploading and downloading file for web

Service Cloud case ID 01922815

Обновления в интерфейсе
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AARI

The form builder now automatically adjusts the size for each form element you drag into the
canvas. The sizes can also be manually adjusted.

Build forms easily by dragging elements to form builder
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AARI

The Tags field in the Edit Process page now has a drop-down menu for you to create new or select
from existing tags.

Define tags in process configuration
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AARI

The Filter automations field in the Add Widget page has a drop-down menu for you to select
existing tags.

Select tags in widget setup

Ссылки, связанные с данной
Заметки о выпуске Automation 360 v.27
Рабочая область RPA v.27 release
Review what's new and changed, and the fixes and limitations in Рабочая область RPA for the v.27
release.
Обнаружение процессов v.27 release
Review what's new in Обнаружение процессов for the v.27 release.
IQ Bot and Document Automation v.27 release
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.27 release.
Bot Insight v.27 release
Review the fixes in Bot Insight for the v.27 release.
Пакеты updated in v.27
Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.

IQ Bot and Document Automation v.27 release
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.27 release.
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Document Automation

Новые возможности

Standard forms integrated with Document Automation
You can create and manage learning instances entirely within Document Automation. Previously,
you had to create standard form learning instances in IQ Bot and then process them through the
Connect Learning Instance feature in Document Automation. With standard forms integrated
with Document Automation, you benefit by having an entire workflow consolidated into a single
system.
Using Document Automation for Стандартные формы.

Support for Microsoft Form Recognizer v3.0 models in Document Automation
Microsoft Form Recognizer v3.0 provides additional capabilities to the existing model creation,
including options to select Template and Neural. While training a model, you can select either 2.1
or 3.0 version.

New Document Automation product licenses
Document Automation now offers the following licenses to enable users to process documents and
track metrics for learning instances in production:
• Document Automation Standard Forms (Number of pages): Required to create a model and

process documents in a Standard form in Document Automation.
• Document Automation 360 Extraction (Number of pages): Required to process documents in an

Automation Anywhere (Pre-trained) model, including the User-defined document type.

Also, there are updates to license consumption tracking.
License tracking release note

Extract data with Google Vision OCR
If you are a user with a Cloud Control Room, you can process documents using Google Vision OCR
technology by creating or updating a learning instance.

Improved table extraction in Automation Anywhere models
You can use validation feedback to train a learning instance to extract data from a cell that contains
more than one field.
For example, if a product description column also includes item number, you can outline the item
number in the Validation interface. When the learning instance processes subsequent documents, it
will extract the item number and ignore the product description.
Using validation feedback to extract specific values in a table

Visualize performance metrics with a new Document Automation widget
You can view data visualizations on Validator user performance. This new widget is a horizontal bar
chart that shows the weighted average time each Validator user spent performing manual validation
per document.
Document Workspace dashboard
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Новые возможности

Document Automation supports regular expression pattern-based extraction
When configuring fields that the learning instance will extract, you can specify a regular expression
(regex) pattern to help the extraction engine find the field. After entering the regex pattern you can
test the expression using sample content within the Create Learning instance window. You can
use regex pattern extraction for values that follow a specific pattern, such as a VAT number or a PO
number.

Validation interface support for shortcut keys
Zoom in and out on documents in the Validation interface by holding the Alt key and scrolling with
your mouse wheel.

Изменения

The following updates impact how the Control Room tracks license consumption:
• The Control Room checks enough product licenses prior to deploying the бот.
• The IQ Bot Pages license and the Standard Forms Pages license track documents that are

processed through learning instances created in Automation 360 IQ Bot. This includes
documents processed in the learning instance in Automation 360 IQ Bot and learning instances
connected to Document Automation.

• In the Licenses page, the Document AI license is called the Google Document AI (number of
documents)

• The Control Room also tracks documents processed in Google Document AI for users who
brought their own license. Previously, the Control Room only tracked such documents for users
who bought their licenses through Automation Anywhere.

You can now configure Oracle Database with on-premises and Linux installations of Document
Automation.

When you import a learning instance created in previous versions of Document Automation, the
check box to send validation feedback to the system is now not selected by default. You must edit
the learning instance to select the check box.

Исправления

Build 16694: This build includes the following fixes (along with fixes from the previous builds):

Now users with either the Стандартные формы for Document Automation or the Стандартные
формы (for IQ Bot) licenses can create a Стандартные формы model in Document Automation.

Build 16685: This build includes the following fixes:

The Bot Agent now clears out the resources folder after running actions from the Document
Extraction пакет.

When you import a learning instance created in a previous version of Document Automation, the
Improve accuracy using validation check box is now unselected by default.

Document Automation now correctly tracks license consumption in all On-Premises installations,
irrespective of the port number.

You can now add formula validation to learning instances with the user-defined document type.
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Исправления

Standard forms in Document Automation is now supported in a fresh installation or upgraded multi-
tenant Control Room. Previously, Standard forms in Document Automation was only supported on a
fresh installation of a multi-tenant Control Room.

When you refresh the Validator page, the Validator displays the last document you worked on.
Previously after a page refresh, the Validator sometimes displayed the first document you had
validated.

Bot Runner devices configured with a proxy can successfully run actions from the Document
Extraction пакет.
Service Cloud case ID: 01856276, 01862174, 01911425

Ограничения

Standard forms only support unique field extraction for any document. If there are fields with the
same name on multiple pages, then the document must be trained with different tag names in the
model creation tool.
For example, if there is a field named date on two different pages, then you must use date1 and
date2 to make the tag names unique in the model creation tool for training.

You cannot use spaces in model names when you create models for Standard forms v3.0. If the
model name contains any spaces, then an InvalidParameter error message is generated.

There is no average accuracy for standard forms v.3.0 from the Microsoft Azure Form Recognizer
service. As a result, the standard forms training displays the average accuracy as 0.00% for the
v.3.0 service.

When fetching a Standard Forms model, an incorrect error message displays when no
configurations are available in Document Automation.

The resizing functionality is not working properly for the model list table. As a result, you cannot
resize the table header or column in Standard Forms.

The run analysis result does not display in standard forms when creating a v.3.0 model with
multipages.

There is a default character limit of 100 characters for the table name, and 155 characters for the
field name of the table. However, if you reconfigure the table, you can add more characters than
the default limit.

The System-Identified Regions (SIRs) for checkboxes or radio buttons are not generated for the
standard forms v.3.0 model.

Standard forms is not supported on Linux.

Any re-mapping or re-drawing in the System-Identified Regions (SIRs) in the Валидатор results in
detection of an incorrect check box. However, you can enter the check box value as checked or
unchecked after changing the auto-generated mapping.

When migrating a learning instance from one Control Room to another, the same user must export
and import the .dw file.
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Ограничения

If the learning instance extracts data from a multi-line field and transfers it to a CSV file, an extra
space is added at the end of each line.

When you mouse over data points in the "Average validation time" and "Validator performance
by number of documents" widgets, the correct values do not immediately display in the pop-up
window.

Document Automation prevents you from creating a learning instance if you create a custom table
field without providing a field name and field label, even if you have unselected the field.

If you click Test regular expression and replace the value in the Regular expression field, the
field now has a limit of 50 characters.
Обходное решение. Click Cancel to leave the Test regular expression window and make the
revisions in the Regular expression field.

The Table icon is not generated on the Form OCR Testing Tool (FOTT) for the Standard form v3.0
Model.

If a field name contains more than 100 characters, the scroll bar does not appear and you cannot
see the value of the form field.

If a table name contains more than 50 characters, you cannot expand the table size. Additionally,
the field name in the table does not display when you hover over it.

If you test an invalid Python script when configuring custom logic, the system returns an error
message that contains the Python execution path.

Sometimes document extraction fails and one of the following error messages appear in the AARI
request status: Extraction bot failed. Please check activity/audit logs for
 more detail or Download bot failed. Please check activity/audit logs for
 more detail with this message in the audit log: Existing deployment in progress for
 this user session.
If this happens, restart the Bot Agent on the impacted device.

The Document Workspace dashboard sometimes shows incorrect page consumption metrics if the
Control Room is installed On-Premises.

Documents cannot be processed with Google Vision OCR if your proxy is configured with a Proxy
Auto-Configuration (PAC) file.

When you create or edit a Learning Instance, if a field name starts with a numerical value, then the
formula validation for that field fails. This issue applies to form fields and table fields.

If you import a learning instance with the validation feedback option disabled, the validation
feedback option becomes enabled and you must manually edit the learning instance to disable the
option.

For Стандартные формы, when a document with multiple pages is processed and enters into
validation, one page is being duplicated in the Валидаторeven when the System-Identified Regions
(SIRs) in the Валидатор are correct.
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IQ Bot

Изменения

If you are using an older version of Microsoft SQL Server that does not support TLS 1.2, then you
must keep an IQ Bot database backup and update to a Microsoft SQL Server version that supports
TLS 1.2.

IQ Bot now uses the latest version of Python (3.11.0) for custom logic validation. To use the latest
version, you must upgrade from cx_Oracle 8.3 to python-oracledb. See Upgrading from cx_Oracle 8.3
to python-oracledb

Исправления

IQ Bot now performs post-processing on fields with Python custom logic that contain single
quotation marks, such as print('Test').

In IQ Bot, when a document is either corrupted, deleted, or is not loading in Валидатор or
Designer, a placeholder image is displayed. The applications will not be consistent until you upload
new documents.
Service Cloud case ID: 00792976, 00835371

During the production process, you must not move the learning instances or bots from Staging to
Production, or vice-versa.
Service Cloud case ID: 01808931, 00821541, 01253373, 00836954, 01271722

When you upload any invalid document in manual or custom groups, then the document gets
processed. However, the System Identified Region (SIR) will not be generated for the unsupported
pages.
Previously, when an invalid document was uploaded with a valid document and processed for
extraction, the See extraction page kept loading.
Service Cloud case ID: 01786098

In Healthcheck API, the output shows the proper branch name convention, for example: RC-
A360.27. Previously, improper health information was displayed when the branch name convention
was heads/RC-A360.27.

If an error or exception is encountered during document validation, the error or exception is
processed, and the files are displayed consistent in the output.
Service Cloud case ID: 00827940

In IQ Bot, if the RabbitMQ v3.8.17 and v3.8.18 is not working, then the log directory location
can now be changed by updating the system environment variable as RABBITMQ_LOG_BASE. If
this variable is provided manually with the required directory location, then the logs are created
and updated in a new location. Previously, the configuration given for the log.dir variable in
rabbitmq.conf file did not support RabbitMQ v3.8.17 and v3.8.18.
Service Cloud case ID: 01844995
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Исправления

The system-identified regions (SIRs) are now generated for manual groups when the PDFBox is
enabled. Previously, when the PDFBox was enabled, during Learning Instance creation the SIRs for
some vector PDFs were not generated for manual groups.
Service Cloud case ID: 01844223, 01849638

You cannot import an IQ Bot archive (IQBA) file when the designer for the same Learning Instance
is open in another window. Previously, the import was failing because the LockedTimestamp field
in the visiobotDetails table had a value at the time of IQBA export. This caused an error because
the LockedTimestamp field was expecting a null value.
Service Cloud case ID: 01818474

Ограничения

During the express installation upgrade of IQ Bot, an error message is shown in the installation
steps. You must click OK to proceed further.

The maximum upload file size limit is set to 5 GB when importing and exporting files in the IQ Bot
archive (IQBA) file. If the file size is greater than 5 GB, then you must delete unwanted groups to
decrease the file size and migrate successfully.

If the IQ Bot archive (IQBA) file size is above 2,147,483,647 bits, then the File Storage does not
upload the exported file from output folder to the desired location.

Sometimes, the PDFBox is unable to detect PDF (Portable Document Format) documents accurately.
We recommend that you use Adobe Acrobat to convert the documents to PDF before you upload it
to IQ Bot.

Обновления в интерфейсе
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IQ Bot и Document Automation

The Create learning instance window now contains a drop-down menu to select an OCR provider.

Extract data with Google Vision OCR

Ссылки, связанные с данной
Заметки о выпуске Automation 360 v.27
Рабочая область RPA v.27 release
Review what's new and changed, and the fixes and limitations in Рабочая область RPA for the v.27
release.
Обнаружение процессов v.27 release
Review what's new in Обнаружение процессов for the v.27 release.
AARI v.27 release
Review what's new and changed, and the fixes and limitations in AARI for the v.27 release.
Bot Insight v.27 release
Review the fixes in Bot Insight for the v.27 release.
Пакеты updated in v.27
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Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.

Bot Insight v.27 release
Review the fixes in Bot Insight for the v.27 release.

Исправления

In the Bot Insight Operations > Bots Dashboard, the бот duration shows the correct data.
Previously, there was a mismatch between the бот duration data and the manual calculation of the
бот duration from the historical menu because of a start time mismatch.
Service Cloud case ID: 01796106

When you upgrade to Automation 360 v.27 and launch the Control Room, no kernel bootup failure
occurs due to a failed Elasticsearch initialization. Thus, it does not show the Bad Gateway error.
As a result, the Control Room service is available and you can access the Control Room URL.
Previously, Elasticsearch initialization failed during startup which was causing the kernel bootup
failure. As a result, the Control Room service was showing the Bad Gateway error.
Service Cloud case ID: 01908667, 01919727, 01919309, 01911464, 01921747, 01926887,
01925309, 01924168, 01929814, 01930226, 01931125, 01925270, 01934212

You can check out and republish the dashboard with a new name for a specific бот after import it
into the public workspace.

Прим.:  In case of public import, you must run the бот at least one time before you export it.

Previously, you could not publish the dashboard for a specific бот even if it was checked in.
Service Cloud case ID: 01763067

Обновления в интерфейсе

Bot Insight

The Bot Insight user interface is changed as per Common Frontend Component (CFC) standards.
Only the look and feel of the components (such as colors, fonts, icons, paddings, borders, buttons,
and so on) is changed, while the underlying functionality remains the same. You can view these
changes from the following user interface elements:
• All Bot Insight pages
• Table pagination position at the center of the page
• The Create widget dialog back drop with the Close button
• Add Widget title in the Create widget dialog
• The Switch Widget button position in the Add widget window for all charts

Ссылки, связанные с данной
Заметки о выпуске Automation 360 v.27
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Рабочая область RPA v.27 release
Review what's new and changed, and the fixes and limitations in Рабочая область RPA for the v.27
release.
Обнаружение процессов v.27 release
Review what's new in Обнаружение процессов for the v.27 release.
AARI v.27 release
Review what's new and changed, and the fixes and limitations in AARI for the v.27 release.
IQ Bot and Document Automation v.27 release
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.27 release.
Пакеты updated in v.27
Review updates to the packages in Automation 360 v.27, including the compatible Control Room and Bot
Agent versions.

Заметки о выпуске Automation 360 v.26
Дата выпуска: 6 October 2022

Review the top 5 features as well as other new features, enhancements, fixes, and limitations in the
Automation 360 v.26 release. Automation 360 and IQ Bot are on Сборка 15459 (for On-Premises and
Cloud).
We have released updated builds for fixes after the GA release of v.26 (Build 15436). For information about
the fixes in these updated builds, see Updated release builds.

Прим.:  The release builds include Manifest V3 browser extensions for Google Chrome and Microsoft Edge
browsers. Для получения дополнительной информации см.
• Chrome and Edge Manifest V3 extensions
• Support for Manifest V3 extensions
• Browser extensions for Automation 360

Highlights of this release

Here are the top 5 features in the v.26 release:

Embedded automation with OAuth 2.0 Business users can directly access authorized
automation from within their favorite business
applications, without having to open a new
interface or learn a new app. OAuth 2.0 enables
seamless authentication across systems, reducing
complexities of system-specific sign-ins.
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Learn more: Embedded Automation.

Coding standards through code analysis Administrators can establish coding best practices
by setting a code analysis policy and improve
their team's code to quickly find and correct rule
violations. They can select which rules to check for
and enable summary reports for a snapshot of all
боты within a project.
Бот builders can quickly check the status of
their боты and receive feedback on what to fix,
speeding up бот development and deployment and
promoting coding best practices.

© 2023 Automation Anywhere. All rights reserved.     174



    Automation Anywhere - Learn

Learn more: Анализ кода.

Пакет role-based access (RBAC) Administrators can tailor пакет access to the
business needs and expertise of бот developers and
enforce access policies for custom groups. They
can maintain policy control and ensure confidence
and ease-of-use for developers by providing group-
based пакет access with clear policies.
Citizen developers can access simpler пакеты
and build easy-to-complete automation, and
professional developers can access a broader set of
complex пакеты.
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Learn more: RBAC on пакеты.

Salesforce integration with command пакет RPA developers can build robust integrations with
Salesforce through direct API interaction. They
can automate repetitive processes involving access
and updates to Salesforce data, enabling business
users to focus on high-value business tasks such
as strategic planning and optimization. Commands
available include authentication, database querying,
record updates, and file processing.

© 2023 Automation Anywhere. All rights reserved.     176



    Automation Anywhere - Learn

Learn more: Salesforce пакет.

Automation 360 integration with Google
Cloud Apigee

RPA developers can fast-track end-to-end
automation development by combining API
components from Apigee and RPA боты from
Automation 360 to access any data in the
enterprise. Our prebuilt integration пакеты make
the integration seamless, enabling you to drive
more value from reusing existing assets created by
your organization's automation teams.
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Learn more: Apigee integration.

Updated release builds

We have released the following updated builds:
• Build 15459 Service Cloud case ID: 01941769, 01945068

This build is updated to include a critical security fix for the issue related to Multi-Factor Authentication
(MFA) when used with database authentication. This vulnerability is not applicable when using SAML or
AD authentication. For more information on this security fix, see Unexpected behavior observed with Two
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Factor Authentication post A360.26 upgrade, where a valid authenticator code alone is sufficient to login to CR,
in spite of an incorrect password.

Прим.:  This issue exists only in Automation 360 v.26 release. For v.26 On-Premises customers using
or planning to use MFA with database authentication, we recommend that you install this update at
your earliest convenience. No action is required from customers on other Automation 360 releases.

• Build 15450 with fixes for the following issues:
• When you import a бот or file that is a manual dependency of other боты using the overwrite

option, the import process no longer removes the dependencies from the other боты (Service Cloud
case ID: 01911410, 01920508).

• When you have large and complex боты with many dependencies and if the size of the deployment
messages that are sent from the Control Room to the Bot Agent is more than 2 MB, the боты run
successfully. (ID обращения к облачному сервису: 01882630).

• The following IQ Bot issues were fixed:
• IQ Bot can now perform post-processing on a field if the custom logic uses Python script

containing single quotes, such as print('Test').
• If your IQ Bot custom logic uses the Pandas library, the script no longer needs to have the

import Pandas statement.
• IQ Bot can now perform post-processing on a field if the custom logic uses Python script

containing characters from non-Latin languages (Unicode characters), such as äöüñй.

• Security fixes for Cross-Site Scripting (XSS) vulnerabilities (Service Cloud case ID: 01843148).

• Build 15443 (for US-East and US-West regions only) Service Cloud case ID: 01911410,
01920508
This build is updated to include a fix for the issue related to the manual dependency file that is shared
between multiple parent боты upon export and import. If one of the child бот files is exported and
imported into the Control Room with overwrite options in the import process, then links to the manual
dependency are unlinked from other parent боты. Use Bot Agent version 21.222 for this issue.

• Build 15439 (Japan region only) Service Cloud case ID: 01911093, 01911209, 01911190,
01911116, 01911259
This build is updated to include a fix for the following issue: Cannot retrieve values assigned
 to global values having Japanese characters after upgrading Automation 360.
Build 15439 is available for download for On-Premises customers who need this fix.

What's new and changed in each product

Go to the following pages for details on all the updates (what's new, changed, fixed, and limitations) in
each product:

RPA Workspace

• Updating to this release
• Migration updates

AARI

IQ Bot and Document Automation

Bot Insight
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Понятия, связанные с данным
View пакет versions available in the Control Room
Actions are grouped into version-specific пакеты. Bot Creator can select which пакет version to use for a
specific бот.
Ссылки, связанные с данной
Рабочая область RPA v.26 release
Review what's new and changed, fixes and limitations, and the feature deprecations in Рабочая область
RPA for the v.26 release.
AARI v.26 release
Review what's new and changed and the fixes in AARI for the v.26 release.
IQ Bot and Document Automation v.26 release
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.26 release.
Bot Insight v.26 release
Review what's changed and the limitations in Bot Insight for the v.26 release.

Рабочая область RPA v.26 release
Review what's new and changed, fixes and limitations, and the feature deprecations in Рабочая область
RPA for the v.26 release.

Новые возможности

Control Room, devices and Bot Agent

Microsoft Windows 11 Enterprise now supported (Service Cloud case ID: 01252605,
1252605, 1253745, 01255134, 01379865, 01801610, 01810148)
We now support Microsoft Windows 11 Enterprise, so you can now install and update the Bot Agent
and run боты on the Windows 11 Enterprise operating system.

Совместимость Bot Agent
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Control Room, devices and Bot Agent

Support for Manifest V3 extensions
Automations that use Google Chrome Manifest V2 based extensions will stop working sometime
after June 2023. The deprecation timelines of Manifest V2 based extensions are currently under
review and subject to change by Google.
• For Google Chrome Manifest V2 extensions timelines, see Manifest V2 support timeline.
• For Microsoft Edge Manifest V2 extensions timelines, see Overview and timelines for migrating to

Manifest V3.

This might impact your existing automations that use Manifest V2 based extensions for Google
Chrome and Microsoft Edge browsers. Automation 360 v.26 and later includes Manifest V3
extensions by default to support features that use Google Chrome and Microsoft Edge browsers.
You can automatically enable Manifest V3 based extensions for Google Chrome and Microsoft Edge
on all the Bot Runner devices by enabling the Browser extensions option from the Control Room.
Enabling this option applies the browser extension settings on all the registered Bot Agent devices.

Прим.:  We will continue to support Manifest V2 based extensions for Google Chrome until June
2023. To know about Microsoft Edge Manifest V2 based extensions timelines, see Overview and
timelines for migrating to Manifest V3.

Прим.:  Manifest V3 extension is supported on Google Chrome and Microsoft Edge browsers
version 91 and later only.

Configure browser extensions | Chrome and Edge Manifest V3 extensions

Bot Agent updates by using installation file from local drive
You can now download the Bot Agent installation file to your local drive as a one-time activity and
then update the Bot Agent on several devices by providing the local drive path to the installation
file. This way, you can avoid downloading the installation file multiple times from the Control Room
for several devices.

Важное замечание:  This functionality is implemented in v.26 and can be used from v.27. That
is, after you update your Bot Agent to v.26, future updates can be performed from the local drive.

Автоматическое обновление Bot Agent | Update the Bot Agent from a local drive

Oracle Database now supported (Service Cloud case ID: 00726728)
We now support Oracle Database, so you can now choose to install the Control Room on Oracle
Database.

Прим.:  Oracle database for Control Room installation is supported only in Custom mode and not
in Express mode. Oracle Database support on the Control Room starts with the v.26 release.

Installing Control Room using custom mode for Oracle installation | Configure Oracle database type and
server | Database requirements
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Control Room, devices and Bot Agent

Active Directory mappings filters stored in the database
When you update to a newer version of the Control Room, you no longer have to define the Active
Directory mapping filters again after installation. This is because the Active Directory mapping filters
defined in the um.properties file are now stored in and can be referenced from the database.
However, if you define new filters in the um.properties file, the Control Room references the
filters defined in the um.properties file and overwrites the ones stored in the database.

Пакеты, actionsи Bot editor

RBAC on пакеты
Based on your business requirements, you can now control the access that Bot Creator have to
пакеты in the Control Room. As an administrator or user with the Manage пакет permission, you
can restrict access to пакеты to either all the users or users with specific roles.
Depending on the access that is configured by the admin, Bot Creator and Citizen Developers can
view and use specific пакеты:
• Bot Creator can access a broad set of complex пакеты and create боты, which can be reused.
• Citizen Developers can access simpler and easy-to-use пакеты and build automations quickly.

RBAC on пакеты | Configure RBAC for пакеты

Salesforce command пакет
You can now authenticate from Automation 360 to access Salesforce and run several command
actions by using the new Salesforce command пакет.
Salesforce пакет

SAP GUI 770 version now supported (Service Cloud case ID: 01793132, 01792775, 1776805,
01792623, 787725, 01805482, 01805479,01792623, 01810356, 01822839, 01851451, 01853577,
01860050)
SAP GUI 770 (patch 6) is now certified and supported with Средство записи and SAP пакет.

Средство записи actions supported in various SAP versions

Configure and use custom proxy configuration in Веб-служба REST пакет (Service Cloud
case ID: 01271527, 01765084, 01839282)
Веб-служба REST пакет is now enhanced to support custom proxy configuration for each Delete,
Get, Patch, Post, and Put action. This provides you more flexibility in calling REST APIs with
different proxy configuration and allow you to create hybrid API automation.

Веб-служба REST пакет

Keyboard shortcuts to reduce scrolling
When developing large боты, you can now use keyboard shortcuts to expand and collapse
individual or all sections and move through the lines of code quickly instead of scrolling and
minimizing sections individually.
Keyboard shortcuts to expand or collapse elements in бот logic
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Пакеты, actionsи Bot editor

Set value in any editable control field to be blank in SAP application (Service Cloud case
ID: 00821861, 01807129)
When you use the Set text action of the SAP пакет, you can now set the value in any editable
control field in the SAP application to be blank. For example, you can set the value in the text field
or the date field to be blank.

Loop through emails and move them one at a time (Service Cloud case ID: 00749763,
01807189, 01840743)
You can now loop through all the emails in a mailbox and move one email at a time to a destination
folder by using the Move action in the Эл. почта пакет.
Move action

Configure p12 certificate for SOAP-based automations (Service Cloud case ID: 00757213)
In the Веб-служба SOAP action, you can now select the p12 certificate file and provide a password
for user authentication. With this enhancement, you can now access web services that use the p12
certificate-based authentication (a more secure type of SSL certificate).

Пример использования действия веб-службы SOAP

Improved accessibility, usability of content on Эмулятор терминала window (Service
Cloud case ID: 01609467)
You can now have improved accessibility and usability of the content displayed on the Эмулятор
терминала window. When you use the enhanced Get text action of the Эмулятор терминала
пакет, you can now view and extract all the lines and text present in the Эмулятор терминала
window and perform an operation based on your requirement.
Using Get text action for Эмулятор терминала

Run боты with or without window title matching in letter case
You can now run боты even when the title of a captured window does not match the letter case.
For a бот to identify a static window or browser titles and titles with a wildcard character, you can
opt for a case-sensitive match if you want the letter case to be matched, or a case-insensitive
match otherwise, by using the Case sensitive option.

Control image preview and storage in Control Room during secure recording
You can now choose whether or not the object images are available for preview and stored in the
Control Room during secure recording by enabling the Recorder preview image setting. When
you enable the setting, the image is previewed in the Bot editor and stored in the Control Room for
60 minutes. If you choose not to preview, images are not captured.

Безопасная запись | Secure recording mode | Настройки

Automate Microsoft Excel spreadsheets from SharePoint
You can now automate Microsoft Excel spreadsheets that are uploaded and shared on SharePoint.
Use Excel advanced > Open action to open the Microsoft Excel spreadsheets from SharePoint
location.
Using the Open action for Расширенный Excel

Automate Citrix Virtual Apps in Edge with IE mode
When using the Средство записи, you can now automate Citrix Virtual Apps running on Microsoft
Edge Chromium with IE mode.
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Пакеты, actionsи Bot editor

Automate controls using Microsoft UI Automation (COM) technology
For automation, you can now use the Microsoft UI Automation (COM) technology in the following
scenarios:
• Capturing controls with secure recording mode
• Capturing and automating combo box and list view controls
• Using Object exists and Object does not exist Средство записи conditions in Если, Цикл,

and Ожидать пакеты

Capture using specific technology | Actions performed on objects captured with Universal Recorder

Seamless automation of Citrix Virtual Apps and other Citrix applications
With the new Automation 360 remote agent for Citrix, you can now seamlessly automate all types
of Citrix Virtual Apps and other Citrix applications that are supported on desktop applications using
the Средство записи.
The new Automation 360 remote agent for Citrix supports the following browsers and technologies:
• Google Chrome
• Internet Explorer
• Microsoft Edge
• Microsoft Edge в режиме IE
• Mozilla Firefox
• Java
• Electron apps
• Microsoft Active Accessibility (MSAA)
• Microsoft UI automation

Installing Automation Anywhere remote agent on Citrix servers | Using the Recorder on Citrix Virtual Apps
servers

Важное замечание:  For information about the supported packages for this release, see Пакеты
updated in Automation 360 v.26.

Building and running боты

Implement coding standards with code analysis
You can now implement best coding practices by configuring coding rules in the Control Room.
This feature helps you prevent potential errors, improve бот reliability, and makes the code more
uniform, accessible, reliable, and efficient.
• As an administrator or a user with View policies and Manage policies permission, you can

configure the code analysis policy for all users.
• As a Непрофессиональный разработчик, you can run code analysis to analyze your боты

against readability, maintenance, security, and compliance best practices.

Анализ кода
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Building and running боты

Choose specific version of child бот to check out with parent бот (Service Cloud case ID:
01771388)
When you check out a parent бот, you can now choose the version of the child бот to check
out. Every version of a parent бот can have different versions of child бот dependencies. With
this feature, you can roll back the dependencies while rolling back the parent бот. You can make
changes to a specific version of the dependent бот.

Easily move боты and files between folders in the private workspace (Service Cloud case
ID: 00733125)
You can now move боты and files effortlessly and without requiring any permissions from one
folder to another in the private workspace. With this feature, if a бот is placed in an incorrect folder,
you no longer have to clone it in the correct folder and then delete it from the incorrect folder.
Move a бот

Better organization with bulk checkin of related боты and files
You can now select multiple боты or dependent files from different folders that belong to the same
process and check them in, in bulk, from private to the public workspace with the same check-in
message. You can check in a maximum of 10 parent боты, but there is no limitation on the number
of dependent child боты.

Email notifications for failed checkins (Service Cloud case ID: 01598642)
As an administrator, you can now configure sending email notifications to бот developers whenever
their checkins fail. Without such email notifications, бот developers will be unaware of their failed
checkins because although the checkin status is always logged in the audit log, they cannot access
the audit log access without permission. With email notifications, бот developers can know about
their failed checkins and retry immediately.

Export work items for offline records (Service Cloud case ID: 01769378, 01798514)
You can now export work items to a CSV file for offline audits and records. With this feature, you
can export selected, filtered, or all work items to a CSV file.
Export work items to CSV file

Export and import queues for efficient and flexible usage
You can now export and import queues across development, testing, and production environments.
This way, you can create a queue in the development environment, test it in the testing
environment, and then promote it to the production environment to efficiently execute business
process workload. You can also include work items when importing a queue.

Экспортировать очередь| Импортировать очередь

APIs and integrations

Connect Bot Agent to Control Room through v1/registration/auto API
You can now use the V1/registration/auto API to register and connect your device to a
Control Room automatically. You must specify the Control Room URL and the userName properties
in the API Request.
Bot Agent API: Auto registration
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APIs and integrations

Fetch execution details for specific execution IDs with new Control Room API
You can now fetch the execution details, such as botOutVariables and CallbackInfo, for a
specific execution ID by using the new API endpoint, V3/activity/execution/<id> API.

Authorization with bearer token
Automation 360 supports the Authorization header with a Bearer token for API requests to the
Control Room. This header was previously unsupported and ignored on API requests. Obtain the
Bearer token from our OAuth services. All API calls must contain either an authentication token from
Authentication API (generates JSON Web token) or a bearer token from OAuth services. You cannot
use both together in an API.

Изменения

Control Room, devices, and Bot Agent

Missed schedules redeployed automatically
You can now ensure that schedules missed because of Control Room shut down (Control Room
maintenance or upgrade) are automatically redeployed.
When you use the Redeploy the schedule again option, an audit log entry identifies the event
type as Schedule misfired, and the бот is automatically redeployed after the Control Room is
restarted.

Low disk space issues resolved with automatic deletion of temp files
Automation 360 now supports automatic clearing of the files in the temp folder, thereby resolving
low disk space issues.
During бот import operations, temporary files were written to the following path, leading to
increased usage of disk space and resultant low disk space issues: C:\Users\<aa cr admin
 account>\AppData\Local\Temp. As a result, the боты failed, and the temp files had to be
cleared manually.

Enhanced Active Directory role mappings page
The Active Directory role mappings page no longer has default validation of mappings.
Validating all the role mappings can take a longer time on slow networks and with a higher number
of mappings because it requires communication between the Control Room database and the
Active Directory server. Also, changes in security groups and roles are infrequent and do not require
frequent validation on this page. The Active Directory role mappings page now displays only the list
of mappings which loads at a faster speed as validation of mappings is not done.

Enhanced autologin functionality for Bot Agent (Service Cloud case ID: 01788805)
Bot Agent autologin now works successfully even if the Interactive logon: Do not require CTRL
+ALT+DEL group policy is disabled.
Previously, for the Bot Agent to autologin successfully, you had to enable this group policy, which
was not possible due to the security policy. As a result, Bot Agent autologin failed.
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Control Room, devices, and Bot Agent

Improved administration for WLM automations
You can now view all the queues with the AAE_Admin role. Also, you can pause, resume, and stop
all WLM automations.

Прим.:  If you are not an owner, participant, or consumer of that queue, you can view only queue
names and not the queue details.

Пакеты, actionsи Bot editor

Run DLL file without namespace (Service Cloud case ID: 01765712)
You can now run a DLL function even if the namespace is not specified because the Enter the
namespace field in the Run Function action of the DLL пакет is now optional.

Casing and format changes in Technology and Control types
When you use the Средство записи to capture objects, you can now read and identify the names
of technology types and control types easily because the names of the properties now use a more
user-friendly casing and format. For example, MS_ACTIVE_ACCESSIBILITY is renamed Microsoft
Active Accessibility.

Исправления

Build 15459: This build includes the following fixes (along with fixes from the previous builds):

A critical security fix for the issue related to Multi-Factor Authentication (MFA) when used with
database authentication. This vulnerability is not applicable when using SAML or AD authentication.
For more information on this security fix, see Unexpected behavior observed with Two Factor
Authentication post A360.26 upgrade, where a valid authenticator code alone is sufficient to login to CR, in
spite of an incorrect password.
Service Cloud case ID: 01941769, 01945068

Build 15450: This build includes the following fixes (along with fixes from the previous builds):

If you have large and complex боты with many dependencies and if the size of the deployment
messages that were sent from the Control Room to the Bot Agent is up to 5 MB, then the боты will
run without failure.
Previously, боты were failing to execute when the size of the deployment messages that were sent
from the Control Room to the Bot Agent was more than 2 MB.
Service Cloud case ID: 01882630

When you import a бот or file that is a manual dependency of other боты using the overwrite
option, the import process no longer removes the dependencies from the other боты.
Previously, manual dependencies were removed for the overwrite option from the other боты
during бот import.
Service Cloud case ID: 01911410, 01920508
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You can select a path containing a dollar sign ($) in a folder trigger for a file and folder, and the бот
will execute successfully. Previously, the бот failed when you selected a path containing a $ in a
folder trigger for a file and folder.
Service Cloud case ID: 01829534

Build 15443 (for US-East and US-West regions only): This build includes the following fixes (along
with fixes from the previous builds):

When you import a бот or file that is a manual dependency of other боты using the overwrite
option, the import process no longer removes the dependencies from the other боты.
Previously, manual dependencies were removed for the overwrite option from the other боты
during бот import.
Service Cloud case ID: 01911410, 01920508

Build 15439 (Japan region only): This build includes the following fixes (along with fixes from the
previous builds):

You can now successfully retrieve values assigned to Global values with Japanese characters after
upgrading the Control Room to the Automation 360 v.26 release.
Service Cloud case ID: 01911093, 01911209, 01911190, 01911116, 01911259

Build 15436: This build includes the following fixes:

You can now successfully delete a device from the device pool without any error.
Previously, when you deleted a device from the device pool, it was deleted from the Control Room
but remained in the DEPLOYMENT_ALLOCATION_QUEUE table. Hence, the device could not be
deleted and an error was shown.
Service Cloud case ID: 01791502, 1840575

If you run a бот from the Bot editor workspace for debugging using the Run from here option
and if the бот contains пакеты that use the session (Local or Global session), the following
compiler error no longer occurs: Unable to find any open session
Service Cloud case ID: 01080318, 01759454, 01785168, 01790014, 01786670

In a multi-user environment, for simultaneous бот deployments, бот launcher logs are now
generated for all the users.
Previously, in such cases, бот launcher logs were not generated for all the users.
Service Cloud case ID: 01759506

You can now successfully list a scheduled task, and the following error no longer occurs: Unknown
timezone ID:US-Pacific-New

Previously, an unsupported time zone could be selected, which resulted in this error.
Service Cloud case ID: 01759074
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If a device is shared between a Bot Creator and a Bot Runner, when you try to edit a schedule, the
following updated message is now displayed: UNKNOWN: All runAsUser(s) should have
default device as no pool is provided. RunAsUser(s): [dprunner] does not
have a default device or that device is shared with a bot creator

Previously, if a device was shared between a Bot Creator and a Bot Runner, when you tried to
edit a schedule, the following incorrect message was displayed: Automation failure due to
deploy failure

When you update the Bot Agent from user level to system level, you can now capture objects
using the Средство записи actions or from a window list in a Google Chrome browser. You
no longer have to manually delete the registry entry in Windows from the current user level
(HKEY_CURRENT_ USER).
Service Cloud case ID: 00731155, 00778022

After connecting to a device, when you set the global cache location to an invalid path, an audit log
entry is generated against the device, and the default global cache path is now used.

Прим.:  Depending on the device used and the path you specified on your drive, validation of the
default cache path might not be supported.

When you want to edit a DataTable variable in debug mode, you can now scroll horizontally to view
all the columns in the DataTable variable.
Service Cloud case ID: 01818834

In the FTP / SFTP пакет, you can now create боты using actions such as Delete files, Put files,
and Get files even if the file name contains characters such as the comma (,) and the colon (:).
Previously, characters such as the comma (,) and the colon (:) were not supported in file names.
Service Cloud case ID: 01772186

You can now run an Enterprise 11.3.3 бот from Automation 360 in the Enterprise 11 Control Room
by using the Run action.
Previously, the Run action did not work for v.11.3.3 because the device V1 API was not working
with an empty filter for release 11.3.3.
Service Cloud case ID: 00825696, 01747999

You can now successfully connect to the Excel or Access (Microsoft Office 2016 or later) engines
with ODBC drivers.
Previously, if you tried to connect frequently to the Excel or Access (Microsoft Office 2016 or later)
engines with ODBC drivers, бот execution failed intermittently.
Service Cloud case ID: 01762290, 01755335, 01778149, 01778899, 01793064, 01788154,
01810754, 01806851, 01811703, 1815437, 01807133, 01799364, 01755642, 01749480, 01767869,
01807133, 01818989, 01815300, 01826839, 01804882, 01842384, 01846477, 01762300, 01331003

When you send an email with multiple file attachments and if attachment size exceeds 24 MB, the
бот now waits for 120 seconds before encountering a timeout error.
Previously, when you sent emails with a large file attachment, бот execution failed after 30 seconds
if the attached file exceeded the file size.
Service Cloud case ID: 01763214
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When you use the Connect action to connect with the EWS protocol, the Send email action and
read email now print the email message body in a new line character in the following scenarios:
• When you create a бот and connect with the EWS server, then use the Loop action to read

email as a plain text messages, and then use the Log to file action to log text into a file.
• When you use the Send email action and connect with the EWS server with OAuth

authentication to send email.

Service Cloud case ID: 01770645, 01780628

In the Email пакет, when you use the Move all action and establish a connection with the EWS
server, if the destination folder contains any of the following special characters in the folder name,
then use a backslash (\) as escape character before the special character: , + , * , ? , ^ ,
 $ , ( , ) , [ , ] , { , } , | , \

For example, if the destination folder name is "4) folder name", enter it as "4\) folder
 name".
Service Cloud case ID: 01803958

If your бот contains an error, Bot error now shows the correct line number of the error within
the Finally block in the following scenario: When you add the Try/Finally block around the
corresponding action, then insert more actions in the Finally block, and then save and run the бот.

You can now successfully upload files whose file names are in the Japanese language by using the
Rest web service action with multipart form data.
Previously, file upload did not work for files whose file names were in the Japanese language.
Service Cloud case ID: 01801767

You can now use the Эмулятор терминала пакет to perform tasks associated with the terminal
without any issues. We now provide support for the Start PC Command (STRPCCMD), so when you
run the бот, the terminal now successfully opens the application with the STRPCCMD command.
Previously, when you passed the appropriate key on the Эмулятор терминала, the бот did
not open the expected application because the STRPCCMD command was not supported in the
Эмулятор терминала.
Service Cloud case ID: 01816577

In the Эмулятор терминала пакет, you can now use the Connect action to connect with a host
machine on which you want to automate a task.
Previously, when you used the Connect action, a black screen was displayed for a few terminal
hosts.
Service Cloud case ID: 01823081, 01841800

After migration, when you open a Load Add-ins-enabled Excel file using the Excel advanced >
Open action and run a бот, the бот now runs successfully without any error.
Previously, the бот failed because some Excel files with the Load Add-ins option enabled stopped
functioning and the workbook was closed unexpectedly.
Service Cloud case ID: 00950745, 01835066

© 2023 Automation Anywhere. All rights reserved.     190



    Automation Anywhere - Learn

When you use the PDF > Merge documents action and select All pages option in the Pages
field to merge all pages of multiple PDF documents into a single PDF document, the output PDF
now retains and merges all the attributes such as bookmarks, links, layers, attachments, and
signatures from the individual source documents.
Service Cloud case ID: 01792105

When the Средство записи fails on a computer where the operating system language is not
English, the error message for the бот runtime failure is now shown in the same language as that
of the operating system.
Previously, the error message was shown in English even on computers where the operating system
language was not English.
Service Cloud case ID: 01813050

You can now successfully extract text from within the captured area of a window using the
Интеграция приложений пакет even if the screen resolution is more than 100 percent.

Automate and capture window authentication dialog boxes in the Google Chrome browser using a
specific technology with the Средство записи.

Боты are no longer stuck when you work with Microsoft Access database queries.
Service Cloud case ID: 01756390

You can now open local files by using the New window option in the Browser > Open action
even if Microsoft Edge is your default browser.
Service Cloud case ID: 01799784

At бот runtime, when you assign a new window title to a window variable, the window variable now
detects the correct window.
Service Cloud case ID: 01788466, 01791773

You no longer encounter a compilation error in the UI in the following scenario:
1. Use the Дата/время пакет released with Automation 360 v.23 or earlier to create a бот that

uses the Datetime > Assign action.
2. Then, select the Variable option to add the variable value.
3. Then run the бот with the пакет released with Automation 360 v.24 or later.

You can now successfully capture objects from applications that are launched from a Citrix machine.

Прим.:  This fix is available only with the new Automation 360 remote agent, which you can use
with the upgraded Средство записи пакет (version 2.8.6-20220823-160834).

Service Cloud case ID: 00831939

When you assign a window title to a window variable, if the variable field has an empty regular
expression value, the бот no longer passes it without scrutiny. Instead, the following error message
is now displayed: Unable to find the window '<window_name>'. The provided
regular expression ‘<regular_expression>' is invalid. Please provide a
valid regular expression for the variable '<variable_value>’.
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When you merge multiple PDF documents by using the PDF > Merge documents action, all the
form field attributes in Adobe Acrobat are merged and the output PDF document is now rendered
properly.
Service Cloud case ID: 01760279, 01792301

When you use the If > Folder does not exist condition to determine whether a folder does not
exist, if the specified folder exists, the бот now successfully recognizes the folder and does not
attempt to create it again.
Previously, because of the presence of leading and trailing spaces in the input folder path, the бот
failed to recognize an existing folder and hence attempted to create the folder, leading to an error.
Service Cloud case ID: 01466067

If you migrate a бот and select the HTML Tag, HTML InnerText, and HTML type properties
and then select HTML-type properties in Search Criteria, the бот now successfully locates and
identifies the object and performs the selected action.
Service Cloud case ID: 00829817, 01757049, 01761452, 01822711

When you use the Средство записи пакет for the Get property action, the correct values are now
displayed for the top, left, height, and width properties.

Прим.:  The Get property action does not display correct values for cross-domain iFrames
elements.

Service Cloud case ID: 01251758

The AISense Recorder пакет now works as expected when you use the Windows 10 operating
system in the Japanese language. Because UTF-8 is now enabled, you no longer need to use any
workaround.
Service Cloud case ID: 01821267, 01822433

When you use 2.8.0-20220601-034227 and later versions of the Средство записи пакет, the
automated бот now returns the correct value for the HTML InnerText property in Google Chrome
and Microsoft Edge browsers.
Service Cloud case ID: 01257098 , 01754795, 01791073, 01787461, 01813080, 01846403

For WLM queues, the date is now displayed in the correct format as YYYY-MM-DD.
Previously, this date was shown in the years ago format, which did not match the date format in the
CSV file and was confusing.

In a multitenant environment, when you upload a work item file to a queue in one of the tenants,
the In progress tab now displays the correct file upload status only in the corresponding tenant.
Previously, the In progress tab displayed the upload status for all the tenants.

When a WLM automation is in progress, an administrator can no longer delete the user who created
that automation.
Previously, the user who created an automation could be deleted, after which that automation could
not be paused or resumed by another user.

When you stop a WLM automation, work items are no longer stuck in the ready-to-run state and
are now moved to the New state.
Previously, when you stopped a WLM automation, a few work items were stuck in the ready-to-run
state and could not be deleted.
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After you change any configuration field in the Administration > Settings > Devices >
Advanced options settings in versions prior to v.25, if the Control Room is updated to v.25, the
Global Cache Location is now set to the default C:/ProgramData/AutomationAnywhere/
GlobalCache value.
Previously, in such cases, no value was shown for the Global Cache Location field, which was
confusing.
Service Cloud case ID: 01869048

When you use the Run bot option to run a бот in the Activity > Historical > View page for any
activity, the бот now runs successfully.
Previously, in such cases, бот execution failed with an error.

When you import a бот that contains manual dependencies, for the overwrite option, the import
process now removes the manual dependencies.
Previously, during бот import, the manual dependencies were not removed for the overwrite option.
Service Cloud case ID: 01813452

When you import a бот into a folder, if a folder with the same name but different letter case already
exists in the repository, бот import now fails with an error.
Previously, in such cases, бот import was successful, but the imported бот failed at the time of
execution because of the wrong folder path.
Service Cloud case ID: 01270324, 01816507

You can now successfully access all the folders in the public workspace without any issues.
Previously, when you imported and cloned a бот under a folder in the public workspace and then
tried to access that folder, sometimes an error occurred, and the folder could not be accessed. This
occurred some times when there were more than 2100 folders under the боты directory.
Service Cloud case ID: 01852748

When you update from Enterprise 11 to Automation 360 or upgrade from an earlier version of
Automation 360 to a later version, the earlier defined group mappings are retained are retained,
even when the Distinguished Name (DN) column of the mapping entries are empty in the database.
Previously, some of the earlier-defined group mappings were deleted due to the empty value for the
DN column.

After you update to Automation 360 v.22 or later, the Repository Management (v2/repository/file/
list) API now returns the correct file size as response output.
Previously, the Repository Management (v2/repository/file/list) API returned the file size as zero in
the response output.
Service Cloud case ID: 01151460

The Azul Zulu JDK is now updated to version 11.0.15+10. The previous version, 11.0.14+9,
contained some vulnerabilities.
Common Vulnerabilities and Exposures (CVEs) for this version are as follows: CVE-2022-34169,
CVE-2022-21540, CVE-2022-21541, CVE-2022-21549, and CVE-2022-34169
Service Cloud case ID: 01854652, 01868897, 01857973, 01854652, 01887083
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Ограничения

When you connect to the Microsoft Access Database with JDBC and specify the database path, and
if you use the following specific aggregation functions in the query, an error occurs when you run
the бот.

ASC, ATN, SQR, CBOOL, CCUR, CDATE,
CDBL, CDEC, CDATE, CDBL, CINT, CLONG, CLNG,
CSIGN, CSTR, CVAR, DATEADD, DATEDIFF, DATEPART,
DATESERIAL, DATEVALUE, FORMAT, IIF, INSTR, INSTRREV,
ISDATE, IsNull, ISNUMERIC, LEFT, LEFTS, LEN, MID,
MONTHNAME, DATE, NOW, NZ, SIGN, SPACE, STR, TIME, VAL,
WEEKDAYNAME, WEEKDAY, STRING, TIMESERIAL, CONCAT

Обходное решение.
1. Go to Administration > Settings > Devices > Advanced options

> Bot launcher JVM options and set the value as follows: -
Dhsqldb.method_class_names=net.ucanaccess.converters*

2. Restart the Automation Anywhere Bot Agent service.

External key vault integrations are not supported on Oracle Database.

Not all missed recurring schedules are redeployed with the Redeploy the schedule again option.
Also, only one entry is shown for the missed recurring schedules in the In progress tab.

As an IQ Bot user, you can check out only the latest version of a process. You cannot check out
previous versions of a process because version check is performed based on the Automation
Anywhere file version and not the Git version.

The OAuth2 configuration settings in the Control Room will not enable you to connect to the
OAuth2 service at this time. Customers planning an OAuth2 integration with our partner application
should expect the service to be available by November.

In the Oracle Database environment, you cannot view a checked-in бот in the Public folder
because version check is performed based on the Automation Anywhere file version and not the Git
version.
Обходное решение. To view a checked-in бот in the Public folder, you must refresh the
Automation page manually by using the Refresh button.

In an Oracle Database environment, when you select the number format and sort order for the
work items in a queue, and then run бот using the Run bot with queue option, the queues are
not deployed. Also, no errors are shown in the Audit log or Activity page.
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For regular or scheduled automations using the unattended Bot Runner, бот deployments remain in
the queued state and accumulate on the In progress page for these following scenarios:
• If the devices are down or not available.
• If a run-as user is busy executing the бот.

For devices not in the deployment state, if the number of queued боты reaches 500, it blocks the
бот deployments for all devices or for all run-as users.
Обходное решение. To run the blocked deployments, perform one of the following actions:
• Select the queued jobs on the In progress page and move it to the Historical page
• Reconnect the Bot Runner devices.

When you set the default package version using the Update bots to default package version
option for боты in the public workspace that are using the Excel Advanced > Open action, the
TaskBots do not display the session name and file path values.
Обходное решение. Perform one of the following workarounds:
• Update the Excel Advanced package manually to use the latest version of the package. См.

Select the package version used in your бот
• Check out the бот and revert to the previous version of the Excel Advanced package. Then,

check in the бот to use the latest version of the package. См. Обновление боты до версии
пакет по умолчанию

Service Cloud case ID: 01905290, 01882083, 00712719, 00728499, 00737694, 00803673,
01255722, 00838604, 00772147, 01760236, 01762679, 01771416, 01761859, 01782588,
01778220, 01784255, 01789551, 01809167, 01818690, 01831969, 01813413, 01287311,
01923711, 01927867

You will encounter an error when you run a standard workflow in the SAP BAPI пакет
Обходное решение. To execute SAP BAPI, use the Run Function call (RFC) with a combination
of Create function, Set or Get field value, Set or Get structure, and Set or Get table
actions.

When you use 2.6.1-20220428-010714 or later versions of the Средство записи пакет to automate
a web page on Microsoft Edge browser, the Средство записи might not be able to perform Click or
Left click actions on the JavaScript alert, prompt, and confirmation pop-up windows.
Обходное решение. For performing the click actions successfully, downgrade the Средство
записи пакет to 2.5.4-20220309-151830 version or earlier.

When you use the Browser > Close action to close a tab or a window opened in the Microsoft
Edge browser, if only one Microsoft Edge browser window is open, the бот encounters the following
error: Error occurred while closing the tab
Обходное решение. См. Configure Microsoft Edge browser settings when Close action of Browser
package encounters an error (A-people login required)

When you run a бот in the Google Chrome or Microsoft Edge browser, use the Если, Цикл, or
Ожидать action, select the webpage from the list of active tabs in the Browser tab, close the
browser window, and then run the бот, the бот might take two minutes to open the webpage in
the browser irrespective of the timeout value mentioned.
Обходное решение. Move the Если, Цикл, or Ожидать action inside the If block and use the
Application is running condition with same browser application to check whether the browser is
running.
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When you run a stored procedure in Oracle and it returns SYS_REFCURSOR, the Run stored
procedure action is not closing the cursors. As a result, after the maximum cursor limit is reached,
this action results in an error.

When you migrate a бот that contains XML command > Get single node, after migration, the
бот encounters the following error: No node found at XPath while executing the Get
Single node command

Обходное решение. If the XPath expression is not starting with (/) , apply XPath starting with
“/“ so that at the time of execution, the modification can be skipped or the XPath expression can
be designed to get the desired result.

While running a бот in debug mode, the бот will fail if the variable size gets greater than 3 MB. An
error message appears showing that a variable has exceeded the 3 MB limit.

When you use the Browser > Open action to automate a browser window running on Google
Chrome and Microsoft Edge browsers, then from the browser window, select More tools > Name
window option to update the title of this window during бот run and then when you try to run the
бот with the updated window title, the бот might fail.

When you use the actions in the Интеграция приложений пакет to extract text from a window,
the бот might not be able to detect the new UI of the Windows 11 operating system and capture
the text.
Обходное решение. Enable the old classical UI in Windows 11 operating system. См.  Restore
Old Classic Notepad in Windows 11

When you use the /v2/repository/file/list, the response lists bots restricted by user
role. If you use this API as an AAE_Admin, you can view bots from the private repository in the
response. Whereas if you use this API as a bot creator, you can view system bots (recorder) in the
response.
Обходное решение. Use the /v2/repository/workspaces/{workspaceType}/files/
list.

Command prompt API allows you to switch the device registration even if the Allow devices
(single user) to be switched to another Control Room without reinstalling bot agent
option is disabled.

When you upgrade from Automation 360 v.25 to a later version, although you enabled code
analysis in the Control Room, the rules set in the policy are not retained after the upgrade.
Обходное решение. Before upgrading, we recommend that you keep a note of the rules
enabled in Automation 360 v.25 and then re-enable them after upgrading to a later version.

Feature deprecations

Review features and capabilities (from Automation Anywhere or other third-party vendors) that are
deprecated or nearing deprecation to understand how they impact your automation.

Automation Anywhere Mobile app deprecated
The Automation Anywhere Mobile app is deprecated as of July 2022 and will not be updated to
subsequent versions of iOS and Android. The mobile app is no longer available and no further
support will be offered. A replacement product is currently not available.
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Tesseract OCR v3 deprecated
Tesseract OCR version 3 is deprecated as of September 2022. If you have created learning
instances using Tesseract OCR version 3, we recommend that you plan to train your learning
instances with alternative OCRs (including Tesseract4 OCR) before you update to Automation 360
v.26.
Deprecation of Tesseract OCR v3

Deprecation of IQ Bot Extraction пакет
The IQ Bot Extractionпакет has been deprecated as of September 2022. As part of Automation 360
v.26, IQ Bot will no longer support pretrained machine learning models for invoice data extraction.
To move your bots from the IQ Bot Extraction пакет to Document Automation, see IQ Bot Extraction
пакет.

Боты RPA для Excel deprecated
Боты RPA для Excel has been deprecated as of January 2022. The plug-in is no longer available
to download as a product. However, support will be offered to current customers already using the
product.
A replacement product as a plug-in for Microsoft Excel is not available. In Боты RPA для Excel, this
action was triggered from within the Excel application. However, as an alternative, new customers
can develop боты for Excel within Automation 360 Рабочая область RPA and use input variables
to allow specifying file names, worksheets, and ranges for боты to operate on. In Боты RPA для
Excel, this action was triggered from within the Excel application, whereas now this action is taken
from the Automation Anywhere Control Room.

G-Suite Apps пакет deprecated
The G-Suite Apps пакет has been deprecated as of September 2022 and it no longer supports
using the Connect and Disconnect actions to establish a connection with the Google server and
automate tasks.
Рекомендации: For specific G-Suite applications, the functionality of the G-Suite Apps пакет is
available in the following G-Suite пакеты:
• Google Диск
• Google Календарь
• Google Таблицы

To automate tasks, in the appropriate G-suite пакет, use the corresponding Connect and
Disconnect actions.

Понятия, связанные с данным
View пакет versions available in the Control Room
Actions are grouped into version-specific пакеты. Bot Creator can select which пакет version to use for a
specific бот.
Ссылки, связанные с данной
Заметки о выпуске Automation 360 v.26
Updating to v.26 release
Review requirements and support information about updating your Control Room and Bot Agent for the
v.26 release.
Migration updates for v.26 release
Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10 versions
to Automation 360 v.26.
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AARI v.26 release
Review what's new and changed and the fixes in AARI for the v.26 release.
IQ Bot and Document Automation v.26 release
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.26 release.
Bot Insight v.26 release
Review what's changed and the limitations in Bot Insight for the v.26 release.

Updating to v.26 release
Review requirements and support information about updating your Control Room and Bot Agent for the
v.26 release.

Обновление Control Room

If you are updating to this release, ensure that the Server audit is not enabled on Сервер SQL Database.
If the server audit is enabled, use SQL administrator user account to turn off the Сервер SQL audit before
initiating the update.

Обновления Bot Agent

Важное замечание:  Этот выпуск включает в себя необязательное обновление Bot Agent. You
can continue to run your existing боты without updating the Bot Agent. However, if you want to use the
new features in Automation 360 v.26, you must update the Bot Agent available with this release.

Более подробную информацию об обновлении до этого выпуска см. на указанных ниже ресурсах.
• Автоматическое обновление Bot Agent | Обновление Bot Agent вручную
• Compatibility with release builds

Supported Control Room builds for direct update

You can update to the latest version of Automation 360 from the previous three releases (that is, from n−3
releases, where n refers to the latest release).
The following previous releases are certified for update to Automation 360 v.26:
• v.25 (Build 15112, 15097)
• v.24R2 (Build 13343), and v.24 (Build 12350, 12342)
• v.23 (сборка 11513)

If you are on one of these previous releases, for information about updating, see Обновление до
последней версии Automation 360. If you are not on an n−3 release, update Automation 360 to one of the
n−3 releases before updating to Automation 360 v.26.
Для получения информации о последних обновлениях до расширений Automation 360 для Google
Chrome, Microsoft Edge и Mozilla Firefox см. раздел Browser extensions for Automation 360.
Ссылки, связанные с данной
Рабочая область RPA v.26 release
Review what's new and changed, fixes and limitations, and the feature deprecations in Рабочая область
RPA for the v.26 release.
Migration updates for v.26 release
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Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10 versions
to Automation 360 v.26.

Migration updates for v.26 release
Review what's new, changed, and the fixes and limitations to migrating from Enterprise 11 and 10 versions
to Automation 360 v.26.

Новые возможности

Enterprise 11 и Enterprise 10

Migrate parent боты independently, avoiding overwrites and loss of updates (Service
Cloud case ID: 01258572, 01778107, 01275417, 01880168)
You can now migrate a parent бот independently even if it has associated child боты. You now
have a choice to select whether you want to migrate a parent бот independently or along with its
dependent child боты.
This helps in avoiding overwrites and loss of updates that might happen when child боты that are
migrated to Automation 360 are updated after migration.

Миграция корпоративных боты

Migrate more боты with specific features
You can now successfully migrate боты in the following cases:
• Боты that use spreadsheets residing in SharePoint by using the Excel advanced > Open

action.
• You can now migrate боты with REST commands with custom proxy configuration at the

Action level. For custom proxy configuration support, in the Bot Migration Wizard, select the
Include web service settings option.
When you select this option, the REST commands are migrated with custom proxy
configurations that use the following global variables:
• AAProxyHost for Hostname
• AAProxyPort for Port

Миграция корпоративных боты
• Боты in which the user interface or window extends beyond the screen on the top-left corner

(truncated) for the following actions: Object Cloning, Если, Цикл, Средство веб-записи, and
Manage Web Control.
Now, migrated боты support windows with negative coordinates (truncated windows).

Enterprise 11 only

Migrate боты independent of Bot Insight migration
Before migration of legacy боты, you can now declare whether these боты were using the Bot
Insight option in Enterprise 11 by selecting the Tag bots and variables for analytics option in
the Bot Migration Wizard. The Bot Insight Open and Close actions are created only for such
migrated боты where this option is selected.

Миграция корпоративных боты
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Изменения

Assess migration readiness of processes with Bot Scanner
The Bot Scanner scans your repository for processes that can be migrated to Automation 360 and
provides information under the following categories:

Прим.:  A process is a бот that is not used in any other бот and can include child боты.

• Все. List of all the processes.
• Action required: List of processes that require action after migration to Automation 360. A

process is flagged as Action Required even if one of its child бот requires action.
• Review required: List of processes that require review after migration to Automation 360. A

process is flagged as Review Required even if one of its child бот requires review.
• No review required: List of processes that can be migrated. All the боты in the process can

be migrated.
• Non Migratable: List of processes that cannot be migrated. All the боты in the process cannot

be migrated.

Прим.:  For generating processes summary report, the maximum repository size that is supported
is up to 10 GB.

Анализ отчета Bot Scanner для миграции

Direct link to upgrade launchpad and migration resource portal in Bot Scanner
Bot Scanner report now also contains direct links to:
• Upgrade Launchpad: Use the information provided on this page for a self-guided experience that

is customized for your migration requirements.
Upgrade Launchpad

• Enterprise Migration Resources: Use the information on this page to plan for migrating to
Automation 360.
Enterprise Migration Resources | Cloud RPA | Automation Anywhere

Анализ отчета Bot Scanner для миграции

Direct link to corresponding migration messages
With a direct link to migration messages in Bot Assistant, you now have quicker access to
information about migrated боты that require action or review.

Validate letter case in window titles
You can now validate the letter case in window titles in window variables. By using the Case
sensitive option, you can now decide whether to match or not match the letter case in window
titles that have the same titles but differ in letter case.
With this option, you can ensure that the migrated боты produce the same output as that of their
corresponding Enterprise 11 боты.
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Review боты more efficiently with exact line number in Bot Scanner report
The Bot Scanner report now displays the exact line number in the боты that need review or
action even in cases where some of the commands used in Enterprise 11 боты are not available in
Automation 360.

Исправления

When you migrate боты with the Select item by index action of the SAP package, the index is
now displayed correctly. The migrated бот selects items according to the correct index, and no error
is displayed.

MetaBots that were captured using the following configurations will now be migrated to Legacy
AISense in Automation 360:

Linked object play mode Main object play mode

Текст Текст

Нет Текст

Previously, боты that used such MetaBot configurations failed to migrate.
Service Cloud case ID: 01774261

You can now migrate TaskBots that use MetaBot Логика whose DLL file contains classes without a
namespace.
Previously, an error occurred when you ran such TaskBots.
Service Cloud case ID: 01765712

When you migrate from Enterprise 11 to Automation 360, capturing MetaBot screen commands is
changed as follows:

Enterprise 11 Automation 360

• Main objects captured with the Object play
mode

• Linked objects captured with the
Coordinate play mode

Record capture actions with the Object play
mode

You can now use commas in the filenames of боты that use FTP actions and use colons in the
filenames of боты that use Delete files and Delete folder FTP actions.
Previously, such боты encountered an error during бот run.
Service Cloud case ID: 01772186

When you migrate боты that use the same window titles but have different letter case in window
variables, the боты now run successfully.
Previously, боты that used the same window titles but had different letter case in window variables
failed to run successfully after migration.
Service Cloud case ID: 00825181
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You can now successfully run migrated боты that use the Email Received Date variable twice in
subactions inside the Эл. почта Цикл action.
Previously, a parse error occurred in such cases.
Service Cloud case ID: 01275815

In migrated боты, when you use the Средство записи пакет, you can now use the Click action on
Client Control in HTML technology without any issues.
Previously, the Click action button on Client Control did not work as expected.
Service Cloud case ID: 01713357

You can now successfully re-edit a migrated бот with the Record > Dataset variable.
Service Cloud case ID: 01807170

When you want to open web pages, in the Браузер пакет, when you use the New window option
of the Open action, you can now specify a URL without the protocol information, such as http,
https, or file.
Previously, when protocol information was not provided in the URL, some web pages did not open
properly.

You can now successfully migrate Enterprise 11 боты with analytics flags.
Previously, migration failed when variables with analytics flags were checked.
Service Cloud case ID: 01768545

When you click the Back button in the migration details page for a migration run, you are now
redirected to the Migration runs tab.
Previously, when you clicked the Back button, you were redirected to the Overview tab.
Service Cloud case ID: 01816558

When you migrate a бот that uses the Manage Window Controls action, the height value is now
set correctly after migration.
Previously, after migration, the last digit of the height value was not available.
Service Cloud case ID: 01756996

When you run a бот to automate spreadsheet data, all the requests are now processed successfully
in the following scenario:
When an Excel session is active in SAP and a corresponding Excel process starts in the background,
Automation 360 creates a separate Excel process other than the one that SAP started, and the
correct window is now activated for all the subsequent requests.
Previously, only the first request was processed successfully because the correct window was not
activated for automating the spreadsheet data for the subsequent requests.
Service Cloud case ID: 00815159
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When you migrate боты from Enterprise 11, the automation priority of each бот is now adjusted to
match its equivalent priority level in Automation 360, as follows:
• In Enterprise 11, if the automation priority for a бот was set to low, after migration, the

automation priority for the бот is changed to medium.
• In Enterprise 11, if the automation priority was set to medium, the automation priority in the

migrated бот is set to high.

Прим.:  There is no change in automation priority when it is set to high.

Previously, the automation priority of migrated боты remained the same as in Enterprise 11.

You can now migrate боты even if the properties value of the Manage Window Controls action is
set to 65536 or more.
Previously, when the properties value was set to 65536 or more, the боты encountered an error
during бот run.
Service Cloud case ID: 01768555, 01825071

After migration, you can now get all the lines of text from the Эмулятор терминала by using the
Get text > All lines action.
Previously, you could get only 24 lines of text from the Эмулятор терминала.
Service Cloud case ID: 01609467

In the Бот migration wizard, the Bot Scanner and the Бот migration report now display the correct
status for боты that are flagged for the R134 migration message.
Previously, in the Bot Scanner and the Бот migration report, the status of боты that required review
was incorrectly displayed as No review required.

You can now successfully migrate боты whose queue category name contains a space.
Previously, migration of such боты failed because Enterprise 11 боты whose queue category name
contained a space went into an infinite loop until the loop timed out at 90 minutes.
Service Cloud case ID: 01850864

After you migrate a бот that uses the Эмулятор терминала пакет, when you run the бот, the
terminal window is now activated and remains in the front. This is because the Show terminal
window in the front option in the Connect action is now enabled by default.
Previously, when you ran such a бот, the terminal window was not activated and remained
minimized because the Show terminal window in the front option was not present in the
Connect action.

When you run a бот with the База данных пакет, the бот no longer becomes stuck at the Insert
or the Update command when run for a long duration.
Previously, in such cases, the бот became stuck intermittently.
Service Cloud case ID: 01836733
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Ограничения

In Enterprise 11, if боты were using the String > Replace action to find a carriage return line
feed (CRLF) character and replace it with another character, after migration, the output might not
be the same as the output seen in Enterprise 11.
Обходное решение. In the Find string option, instead of the Enter (LF) variable, use the
Newline (CRLF) variable.
Service Cloud case ID: 01808878

In Enterprise 11, if боты were using the Если, IF/ELSE, or Loop While command in Windows
Control and if the Application window does not exist, after migration, the боты will encounter an
error during бот run.
Service Cloud case ID: 01846262

When the Select query is used inside a Цикл command and its result set is further iterated, if the
query returns no record, the result set Цикл reiterates the previous record.
Service Cloud case ID: 01799961

Ссылки, связанные с данной
Рабочая область RPA v.26 release
Review what's new and changed, fixes and limitations, and the feature deprecations in Рабочая область
RPA for the v.26 release.
Updating to v.26 release
Review requirements and support information about updating your Control Room and Bot Agent for the
v.26 release.

AARI v.26 release
Review what's new and changed and the fixes in AARI for the v.26 release.

Новые возможности

Embedded automation with OAuth 2.0
Embedded automation streamlines access to the automation experience.
Embedded Automation

• AARI Integrations embeds in web applications as a widget, so if you are an end user, you can
access automated processes and боты without leaving your environment.

• AARI Extensions offers further adaptability through Chrome browser extensions, enabling
automation directly in any web scenario. Business users can now access automations through a
widget, available through an extension in their web browser.

• With an OAuth 2.0 connection, existing access to automations in the Control Room are now
shared with the Extensions to offer you a seamless user experience.

AARI Integrations и AARI Extensions
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Oracle Database support
We now support AARI on Oracle Database. When you install or update to this release, you can now
choose Oracle Database to work with AARI.

Delete files permanently from AARI cloud storage
You can now delete files permanently from AARI cloud storage. When you delete a request, the
associated file is also permanently deleted now and not just sent to the recycle bin.
Cloud storage usage

Append or overwrite operations in your form
Append or overwrite operations in your form by using the Assign form rules for the web, with the
Checkbox and Radio Button elements, which now support form rules.

Assign dynamic values with support for new elements in your forms
When you use the interactive forms пакет, you can now assign dynamic values with the Assign
action, which now supports Checkbox and Radio Button elements in your form.
You can also change the label of the selected form elements with the Change label action for the
Button element.
Interactive forms пакет

Run processes more seamlessly by setting expiration time for human tasks (Service
Cloud case ID: 00806522)
You can now run your process more seamlessly even when a human task takes longer to run. You
can achieve this by setting an expiration time for your tasks in Human Task in a process.
When you set an expiration time, if a human task takes longer to address, the task times out and
the process moves to the next step to ensure there is no break to the flow.
You can set the expiration time by number of days, hours, and minutes, depending on your
requirement.

Создание процесса AARI

Изменения

Simplify your workflow by grouping multiple conditions in form rules
You can now group multiple conditions for your form rules by using the And logic with the Or logic.
Previously, you could group only the And logic or the Or logic. This change, which is similar to the
If-Then-Else logic, facilitates grouping multiple conditions and helps simplify your workflow.
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Исправления

You can now have greater security validation because it is no longer possible to upload files that
have double extensions, such as File.PDF.PDF, to your web application.
Previously, uploading files with double extensions was possible, which represented a significant risk
to applications.
Service Cloud case ID: 00828289

Repetitive error messages do not appear in logs. Clean up operations now include recursive request
files to prevent spam in audit logs.
Service Cloud case ID: 01816489, 01839604

When you use the Has Errors rule to show the number of errors in your form, the error message
now shows the correct number of errors.

When you update from Automation 360 v.24R2 to Automation 360 v.25, the бот setup now
correctly shows the number of боты and assigned teams.

Ссылки, связанные с данной
Заметки о выпуске Automation 360 v.26
Рабочая область RPA v.26 release
Review what's new and changed, fixes and limitations, and the feature deprecations in Рабочая область
RPA for the v.26 release.
IQ Bot and Document Automation v.26 release
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.26 release.
Bot Insight v.26 release
Review what's changed and the limitations in Bot Insight for the v.26 release.

IQ Bot and Document Automation v.26 release
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.26 release.

Document Automation

Новые возможности

Improve extraction by providing changes to the Валидатор
You can now improve extraction by providing learning instances with validation feedback for
Automation Anywhere models. You can achieve this by enabling the Validation feedback option
in the Create learning instance and Edit learning instance windows.
Data extraction in Document Automation

Search for form or table fields
When creating a learning instance, when you are configuring fields, you can now search for fields
by field name, field label, or data type.
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Новые возможности

Process invoice-like documents with user-defined document type
You can now process documents that are visually similar to invoices, such as purchase orders and
sales orders, which contain key-value pairs and a table structure. You can achieve this by create
learning instances with the user-defined document type, using which you can also achieve the
following results:
• Extract from English, Dutch, French, German, Italian, Portuguese (Brazilian), and Spanish

language documents.
• Define exactly which values to extract from a field, such as when a date of birth field also

contains the age.
• Use the Address data type for form fields, which identifies and extracts the structure of an

address.

Enhancements to the Валидатор
• The Валидатор now shows the group number for documents processed in a learning instance

connected from Automation 360 IQ Bot
• You can now configure a list of valid values when creating learning instance.
• When you click a field that requires validation, a message now appears with the confidence level

determined by the system and the threshold set in the learning instance.

Monitor document processing metrics in Bot Insight dashboards
You can now visualize data, such as the number of documents uploaded per day, extraction
time per document by learning instance, and STP percentage by learning instance, by using the
customizable dashboards in the Document Workspace tab.
Document Workspace dashboard

Document Automation now supports the bring your own key (BYOK) use case for the
Google Document AI product license
Users can now configure their Control Room environment with Google Document AI licenses
purchased from Google. This allows the learning instance to send documents to Google Document
AI for extraction and for the Control Room to track consumption in the All licenses page.
Configure key for Google Document AI | Лицензии Automation 360

View Document Automation user activities in the audit log
With the AAE_Администрирование role or a custom role with the View audit log permission,
you can now view the status of events related to learning instances, domains, and documents.

Журнал аудита
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Новые возможности

Create and train standard forms within the Control Room
Users with the AAE_Администратор IQ Bot or AAE_Службы IQ Bot roles can now create
new standard forms in Document Automation. It is no longer necessary to leave the Control Room
and open a third-party service to create or modify a standard form. The interface to configure the
extraction model is launched from the Learning instances page.

Прим.:  To process documents in a learning instance which uses the standard forms model in
Document Automation:
1. Create the standard form in Document Automation.
2. Create and train the learning instance in Automation 360 IQ Bot.
3. Connect the learning instance to Document Automation.

Create standard form in Document Automation

Изменения

To connect a learning instance from Automation 360 IQ Bot, you must have one of the following
roles:
• AAE_Администратор IQ Bot
• AAE_Службы IQ Bot
• Пользовательская функция с разрешением Подключение обучаемого экземпляра

Uploaded documents and extracted data are now removed after 90 days even if a document has
not completed processing, except in the following cases:
• If data is downloaded and deleted, the source documents are immediately deleted.
• If the document is manually validated, the document is stored for 90 days from the date of

extraction.

If a document is renamed to a new file extension and uploaded to a Google Document AI
pretrained model, the document will fail processing.
Обходное решение. Rename the document to the correct file extension.

Исправления

Beside the Validate documents link, the value that reflects the number of documents awaiting
validation is no longer hidden, and you can now view it without adjusting the width of the Actions
column.
Previously, you had to adjust the width of the Actions column to see the value.

You can now successfully draw a box, zoom in, fit the box to match the screen size, and then
redraw the box without any issue.
Previously, when you drew a box, zoomed in, clicked Fit to screen, and then tried to redraw the
box, the box appeared at a different location from where you clicked.
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Исправления

In the Validator, you can now adjust the system-identified region (SIR) by dragging the corners of
the SIR when you zoom in or zoom out.
Previously, you could drag the corners of the SIR but not when you zoomed in or zoomed out.

When you connect to a learning instance from Automation 360 IQ Bot, if the learning instance has
an optional field with a set default value and some fields that are unmapped, when you process
documents in that learning instance in Document Automation, the default value now appears only
in the mapped fields.
Previously, the default value appeared incorrectly in the unmapped fields.

In Community Edition, when you try to delete a learning instance, the following, correct message
is now displayed and you can successfully delete the learning instance: Community edition
 users are limited to 5 learning instances

Previously, although you could delete the learning instance, the following, incorrect message was
displayed: Community edition users are limited to 5 learning instances and
 will not be able to delete.

Fixed an issue where Document Automation sometimes failed to extract data from tables that span
across multiple pages. Document Automation now supports data extraction from tables that span
across multiple pages for Automation Anywhere models.

You can now use the Document Extraction > Download action in a standalone бот that is not
part of an AARI process.
Previously, this action could be used only in the Downloadbot within the AARI process that was
automatically generated when a user created a learning instance.

After the Валидатор times out because of inactivity, when you refresh it, instead of showing the
most recent document that you validated, the Валидатор shows the first document that you
validated.

Ограничения

Document Automation does not support Cloud-enabled (SDS) deployment.

Formula validation does not support numbers that contain delimiters. For example, 1,000 and 2.0
are not supported.

В некоторых случаях Bot Agent не очищает свою папку ресурсов. Пока дисковое пространство
не будет освобождено, это будет влиять на производственные документы, находящиеся в
обработке. Эта проблема возникает периодически.
Обходное решение. Исходя из проблемы, необходимо создать планировщик задач для
очистки папки ресурсов каждый день или каждую неделю.

There is no notification when the product license is about to expire. По истечении срока действия
лицензии вкладка Обучаемые экземпляры удаляется из Control Room.

Learning instances that use Google Document AI models do not reliably extract all the fields in a
table, if the table that spans multiple pages.

© 2023 Automation Anywhere. All rights reserved.     209



    Automation Anywhere - Learn

Ограничения

In On-Premises installation in Linux environments, document processing sometimes fails because of
a storage service error.
Обходное решение. In the command prompt, run the following script:

cd /opt/automationanywhere/automation360/appdata/Server Files/
sudo chown -R crstorage:controlroom storageservice

Document Automation does not support Oracle Database for On-Premises installations.

Document Automation supports only the following standard ports for On-Premises installations:
• For HTTP: Port 80
• For HTTPS: Port 443

Sometimes, files uploaded to train a standard form appear corrupted although the data is still
usable.

Standard forms in Document Automation is not supported in a multi-tenant Cloud Control Room
that was upgraded from v.25. This limitation does not occur on a fresh installation of a multi-tenant
Cloud Control Room.

Learning instances with the user-defined document type do not support Dutch language
documents.

The first time you click a learning instance connected from Automation 360 IQ Bot, you are
redirected to the IQ Bot homepage instead of the details page for that learning instance.

Formula validation is not supported for custom fields if the field name contains a space.

When you import a learning instance created in a previous version of Document Automation, the
check box to send validation feedback to the system is unselected by default. You must edit the
learning instance to select the check box.

Document Automation does not perform post-processing on connected learning instances that
contain Python custom logic with either of the following:
• Single quotes, such as print('Test'). Ensure the Python script uses only double quotes.
• Characters from non-Latin languages (Unicode characters), such as äöüñй.

Formula validation is not supported in learning instances with the user-defined document type.

When you process documents using the IQ Bot Extraction пакет, the Python scripts are not applied
properly on the form fields for the classic learning instances connected on Document Automation.
This results in improper data extraction in the output CSV files and the Валидатор.

When you click the Table icon on Form OCR Testing Tool (FOTT) editor, the text appearing on the
pop-up window is not readable.

If IQ Bot,Control Room, and Bot Agent are installed on the same Windows Server 2012 , then data
extraction fails for any Classic learning instances connected in Document Automation.
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IQ Bot

Новые возможности

When user logs out, lock released immediately on documents in Validator
When a user logs out of IQ Bot, the lock on the documents in validation is now released
immediately so that other users can view or validate the documents. Previously, when a document
was in the Validator queue, if the logged out, the lock on the document in the validator was not
released immediately, as a result of which other users could not view or validate the document.
Use the IQ Bot Валидатор

IQ Bot Database Migration Assistant Tool now supports Windows Authentication
When you migrate from Enterprise 11 to Automation 360 by using the Database Migration Assistant
Tool, you can now use Windows Authentication for connecting to the IQ Bot database server.

Choose classification type while creating learning instance
When you create a learning instance, you can now choose which aliases and fields are considered
for classification by using the Disable classification changes on domain modification (fields,
alias) check box.
• When this check box is selected, the classification process uses only the aliases or fields that

were present in the domain when the learning instance was created. Aliases and fields added to
the domain after the learning instance was created are not considered for classification.

• When this check box is cleared, the classification process uses all the aliases or fields that are
part of your domain. Aliases and fields added to the domain after the learning instance was
created are also taken into consideration for classification.

This feature classifies the document to the same group even if there are any updates in the
domain.

Изменения

Upgraded machine learning models
IQ Bot now uses an upgraded machine learning model for detection of check boxes and Advanced
tables.

Python libraries upgraded to 64-bit
All the Python libraries provided in IQ Bot by Automation Anywhere for this release are now
upgraded to 64-bit from 32-bit. If you are using third-party libraries, ensure that you upgrade
to 64-bit libraries. After upgrading the third-party libraries, ensure that these libraries work
successfully.

Исправления

When you download an unclassified document, click Delete from the server, and then toggle
the learning instance from production to staging and back, the document no longer appears in the
untrained folder. Previously, when you downloaded an unclassified document from the untrained
groups, even after you deleted it, the document still reappeared in the folder.
Service Cloud case ID: 01781935

© 2023 Automation Anywhere. All rights reserved.     211



    Automation Anywhere - Learn

Исправления

When you upload documents, the Classifier no longer halts or becomes stuck. Documents that
are not classified are now cleared from the queue, allowing smoother processing of subsequent
documents. If these documents fail to be processed within the timeout limit, they are now
categorized as unclassified and you can download these unclassified documents.
Service Cloud case ID: 01762844, 01272642, 01750753

You can now install IQ Bot by using Windows authentication and CyberArk Vault and then rotate
the key. Previously, when you tried to rotate the Vault key, the following error message was
displayed: Произошла ошибка при установке нового ключа.Проверьте журналы

You can now select multiple learning instances for backup by using the Search drop-down list.
Previously, after you clicked the Create Backup option on the Migration Management page,
if you selected a learning instance and then used the Search drop-down list to select another
learning instance, the previously selected learning instance became deselected.

The value displayed in the My totals > Accuracy field now matches the value in My learning
instances > Field accuracy for the available learning instances.

You can now add documents to manually created groups and upload documents to staging.
Previously, when you edited a manually created group or tried to upload a document, you
encountered an error and the following error message was displayed: Failed to update
 manual group: Duplicate label found.

Service Cloud case ID: 01849616, 01845590

You can now use the migration utility to successfully migrate learning instances created for
a custom domain. When you import IQBA files with duplicate fields (even through an API),
the following message is displayed alerting you to the existence of duplicate fields: Error:
 Duplicate field found Invoice number. Previously, the migration utility could not be
used to migrate learning instances created for a custom domain.
Service Cloud case ID: 00729627

During migration, you can now successfully import and export IQBA files. Previously, the import
and export of IQBA files failed because the content classification table contained duplicate training
fields.
Service Cloud case ID: 00826891

When a document is successfully downloaded, it is now placed in the Success folder. Previously,
documents that were successfully processed were sent to the untrained folder, causing
inconsistencies in the download process.
Service Cloud case ID: 00780227,00842077

When there is an update in the domain, IQ Bot now classifies a document to the same group.
Previously, whenever there was any update in the domain, IQ Bot created new groups for the same
document.
Service Cloud case ID:01622981

If a document without content is uploaded to a learning instance in production, the following
message is logged in the bot_launcher.log file: Unable to upload file <filename> to the
 Learning Instance. No content in file, size 0" whenever there is a 0 KB
 file is uploaded.

© 2023 Automation Anywhere. All rights reserved.     212



    Automation Anywhere - Learn

Исправления

The security vulnerability related to Unquoted Service Path has been fixed. Previously, the
Windows host referred to an installed service that used an unquoted service path containing
whitespace Automation Anywhere Cognitive Console: D:\Program Files (x86)\Automation
 Anywhere IQ Bot\Portal\node modules\winser\bin\nssm64.exe, which resulted in
the vulnerability.
Service Cloud case ID:01880370

Ограничения

You cannot create a бот in IQ Bot when an invalid document is uploaded to a custom or manual
group. Also, when an invalid document is uploaded along with a valid document and processed for
extraction, the See extraction page keeps loading.

IQ Bot does not support Oracle Database for on-premises installations.

During production processing, if a learning instance is switched from Production to Staging or the
other way around, for any documents processed during this switch, the production document that
appears in Validator is blurred and not in human-readable form.

IQ Bot does not perform post-processing on a field if the custom logic uses Python script containing
single quotes, such as print('Test'). Ensure the Python script uses only double quotes.
Custom Logic Python script challenges in A360.26 IQBot (A-people login required)

If your IQ Bot custom logic uses the Pandas library, the script must have the import Pandas
statement.

IQ Bot does not perform post-processing on a field if the custom logic uses Python script containing
characters from non-Latin languages (Unicode characters), such as äöüñй.

In IQ Bot, when you run a script created on versions prior to Automation 360 v.26, you might see a
warning. However, this does not impact the script execution and the functionality.

Ссылки, связанные с данной
Заметки о выпуске Automation 360 v.26
Рабочая область RPA v.26 release
Review what's new and changed, fixes and limitations, and the feature deprecations in Рабочая область
RPA for the v.26 release.
AARI v.26 release
Review what's new and changed and the fixes in AARI for the v.26 release.
Bot Insight v.26 release
Review what's changed and the limitations in Bot Insight for the v.26 release.

Bot Insight v.26 release
Review what's changed and the limitations in Bot Insight for the v.26 release.
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Изменения

With the expanded user interface, you can now gain more insights into the Document Workspace. A
new dashboard is available that delivers insights to Document Automation activity and trends, such
as number of uploaded documents, pages and average extraction time. See more information in the
following topic.
Document Workspace dashboard

Ограничения

DataTable widgets for Bot Insight dashboards currently show a maximum of 100 records.
Service Cloud case ID: 01820004, 01851999, 00760252, 00806950

To avoid errors from occurring during bot lifecycle management, the private workspace dashboards
will be imported only when the бот is imported directly to the private workspace.
Importing a бот to the public workspace and checking the бот out to the private workspace will not
import the associated private workspace dashboards.
Service Cloud case ID: 00760022, 01803726, 01794757, 01777561, 01780407, 01842554,
01874606

Connectors for Bot Insight, such as Tableau or Power BI, work only with the following
authentication mechanisms:
• Authentication based on Control Room database
• Authentication based on Active directory

Service Cloud case ID: 01863601, 01909212

Ссылки, связанные с данной
Заметки о выпуске Automation 360 v.26
Рабочая область RPA v.26 release
Review what's new and changed, fixes and limitations, and the feature deprecations in Рабочая область
RPA for the v.26 release.
AARI v.26 release
Review what's new and changed and the fixes in AARI for the v.26 release.
IQ Bot and Document Automation v.26 release
Review what's new and changed, and the fixes and limitations in IQ Bot and Document Automation for the
v.26 release.

Заметки о выпуске Automation 360 v.25
Дата выпуска: 28 июня 2022 года
Review what's new and changed, and the fixes and limitations in the Automation 360 v.25 release.
• Control Room. Cloud Сборка 14304 (replaces Build 14298) and On-Premises Сборка 15112 (replaces

Build 15097)
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• IQ Bot. Cloud Сборка 14304 (replaces Build 14298) and On-Premises Сборка 15112 (replaces Build
15097)

Важное замечание:  Manifest V3 based extensions - Google will deprecate Manifest V2 based
extensions for Google Chrome by January 2024. . To know about Microsoft Edge Manifest V2 based
extensions timelines, see Overview and timelines for migrating to Manifest V3. The deprecation might impact
your existing automation that use current Manifest V2 based extensions in Google Chrome and Microsoft
Edge browsers. Use the Automation 360 v.25 Build 15118 and Bot Agent version 21.211 for the latest
Manifest V3 based extensions updates to support features that use Google Chrome and Microsoft Edge
browsers. This build is available for download in the link provided in the following article: Everything about
the Chrome/Edge Manifest V2 Deprecation. См. Chrome and Edge Manifest V3 extensions и Everything about the
Chrome/Edge Manifest V2 Deprecation.
If you want to continue using the earlier builds of Automation 360 v.25 (Сборка 15112 or 15097) but want
to upgrade to Manifest V3, you can manually upgrade to Manifest V3. См. раздел Manifest extension manual
upgrade.

Важное замечание:  We have updated the Cloud Сборка 14304 and On-Premises Сборка 15112 to
include fixes for the following issues. Fixes specific to On-Premises or Cloud builds are indicated.
• When you created or deleted new users, multiple, duplicate audit log entries were generated for a

single user (Service Cloud case ID: 01836296).
• When you logged in to the Control Room with бот export permissions, when you exported a task, no

corresponding entry was immediately visible in historical activity (Service Cloud case ID: 01834139,
01839933, 01841993, 01839817, 01834108, 01846407, 01845706, 01843349, 01846220, 01846819,
01845547, 01847028, 01847024, 01847094, 01847114, 01847115, 01846998, 01847840, 01846757,
01848123,01846944, 01848104, 01848294, 01848905, 01846596, 01849748).

• When you updated to Automation 360 v.25 and attempted to use the previous settings with instance
names, the previous settings were not allowing an update (Service Cloud case ID: 01838276,
01835897).

• (On-Premises only) When you deployed a task On-Premises without direct Internet access, the
compilation slowed down (Service Cloud case ID: 01841448, 1839118, 1844817, 01846153, 01846332,
01839254).

• When the wait for condition пакет was used with any command пакет, the set timeout value for
the wait was not met (Service Cloud case ID: 01842547, 01846156, 01847338, 01846324, 1842368,
01847054, 01848080, 01848789, 01848151, 01848963, 01847054, 01847121, 01848236, 01848260,
01849016, 01848248, 01848572, 01847828, 01847055, 01848826, 01848191, 01848944, 01851181,
01849792, 01852057, 01846152).

• When you update from any build to Automation 360 v.25, if changes were made to the If/Else logic
in nest and saved, a new Go to End point element was added, which created a process error (Service
Cloud case ID: 01848192).

• (On-Premises only) When an AARI process was checked in and then checked out, the mapped variables
did not persist and were lost (Service Cloud case ID: 01847675).

This page includes the following sections:
• Миграция

• 11.x and 10.x
• 11.x only
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• Рабочая область RPA
• What's new | What's changed | Summary of changes in пакеты
• Fixes | Limitations (this release) | Limitations (previous releases)

• Internet Explorer EOL updates
• Features

• AARI
• Новые возможности |  Изменения | Исправления | Ограничения

• Discovery Bot
• Fix

• Document Automation
• New capability | Limitations

• IQ Bot
• Новые возможности |  Изменения | Исправления | Ограничения

• Bot Insight
• What's changed | Fixes

• Automation Anywhere for Genesys
• Новые возможности

• Feature deprecations
• Summary list

Top 5 developer features in this release

View the following video on the top 5 developer features:

Обновление до этого выпуска

If you are on the previous build (Build 15097) of Automation 360 v.25, you must update to the latest
Сборка 15112.
You can update to the latest version of Automation 360 from the previous three releases (that is, from n−3
releases, where n refers to the latest release).
The following previous releases are certified for update to Automation 360 v.25:
• v.24R2 (Build 13343), and v.24 (Build 12350, 12342)
• v.23 (сборка 11513)
• v.22 (сборка 10526)

См. также A360 | Upgrading to A360.23, A360.24, A360.25 from A360.22 (A-People login required).

When updating from previous releases to v.25 (Build 15097), ensure that you review the information in the
following article: Error parsing the SQL instance name while upgrading to Automation 360 v.25 (A-People login
required).
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If you are on one of these previous releases, for information about updating, see Обновление до
последней версии Automation 360. If you are not on an n−3 release, update Automation 360 to one of the
n−3 releases before updating to Automation 360 v.25.

Важное замечание:  Этот выпуск включает в себя необязательное обновление Bot Agent. You
can continue to run your existing боты without updating the Bot Agent. However, if you want to use the
new features in Automation 360 v.25, you must update the Bot Agent available with this release.

For more information, see these resources:
• Автоматическое обновление Bot Agent | Обновление Bot Agent вручную
• Compatibility with release builds

Для получения информации о последних обновлениях до расширений Automation 360 для Google
Chrome, Microsoft Edge и Mozilla Firefox см. раздел Browser extensions for Automation 360.

Миграция

Особенности Enterprise 11 и Enterprise 10

Миграция TaskBots, когда связанная Логика MetaBot переименована
Теперь вы можете успешно выполнить миграцию TaskBots в тех случаях, когда связанная
Логика MetaBot переименована или изменила относительный путь после сопоставления.
Если Логика MetaBot переименована или изменила путь после сопоставления в TaskBot, то
теперь выполняется миграция TaskBot с новым именем или путем Логика MetaBot.
Путь команды в TaskBot обновляется с измененным именем или обновленным путем.
Изменение относительного пути применимо в следующих сценариях.
• Логика перемещается из одной папки в другую.
• Логика перемещается из папки корневого уровня MetaBot в подпапку.
• Логика перемещается из подпапки в папку корневого уровня MetaBot.
• Папка, в которой находится Логика, переименовывается.

Это усовершенствование относится к указанным ниже командам.
• Запустить логику
• Если > Logic Successful
• Если > Logic Unsuccessful
• Обработка ошибок

Расширенный выходной отчет Bot Scanner
В выходном отчете Bot Scanner, когда вы щелкаете по имени бот, требующего
корректирующих действий, теперь отображается Номер строки команд вместо Общее
количество сообщений (частота).
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Особенности Enterprise 11 и Enterprise 10

Поддержка миграции для action «Отправить сообщение эл. почты» с несколькими
вложениями
Теперь можно переносить боты, содержащие команду Отправить сообщение эл. почты, с
указанием пути к файлу в переменной для указанных ниже сценариев.
• В качестве вложения отправляется один файл.
• Несколько вложений отправляются в одном сообщении электронной почты.
• Файлы прикрепляются с сетевого диска.

Migration support for Work Item variable (Service Cloud case ID: 01270496)
Теперь можно переносить боты с переменной Work Item для сценариев, в которых
переменная Work Item включает в себя следующее:
• цифру,
• цифру и строку, например окно сообщения,
• дату,
• сочетание Дата/время и строки, например окно сообщения.

Прим.:  Если переменная Work Item относится к типу Дата/время, автоматически
добавляется действие Запись: Присвоить, которое затем преобразуется в переменную
строки типа Дата/время, перед применением переменной Work Item.

Переменные, созданные автоматически после миграции
В утилите Bot Scanner боты, которые содержат следующие переменные без ссылок, больше
не имеют меток Требуется действие или Требуется проверка:
• $FileName$
• $Error Description$
• $Error Line Number$
• $Extension$
• $Folder Name$

После миграции система автоматически создает эти переменные в соответствии с правилами
именования Automation 360 и перенесенные боты успешно запускаются.

Усовершенствование миграции для пакеты и actions
• Если перенесенные боты используют действие PDF — Извлечь текст >

Структурированный текст, новый параметр Уменьшить потерю данных
обеспечивает сохранение символов в извлеченном тексте и успешный запуск ботов.

• Если у вас есть боты с определенным выражением Xpath в пакете Веб-служба SOAP,
убедитесь, что данные, полученные при выполнении команды SOAP, для параметра
Выбранный ответ возвращаются должным образом, выбрав Разделенная строка
или Список строк. Для перенесенных ботов по умолчанию выбирается параметр
Неразделенная строка.

• If migrated боты use the Эмулятор терминала, the Set cursor position to the beginning
option now enables you to edit the Terminal Emulator screen manually, and the focus is set
to the beginning of the editable field. Note that this option is selected by default only when
the Show terminal option is selected for these боты. (ID обращения к облачному сервису:
00812730, 01252363, 01804623)
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Особенности Enterprise 11 и Enterprise 10

Support for 7-Zip
We have certified 7-Zip, a third-party tool, to handle backing up the Control Room repository with
lengthy file names, бот names, and folder names. You can now back up and restore the repository
of боты even when the length of the filepath to the repository of боты exceeds 256 characters.
You can run either 7z.exe commands using the command line interface or run the 7.Zip as an
application.
The 7-Zip tool support is available on the following Automation Anywhere certified Windows
operating systems:
• Microsoft Windows Server 2016
• Microsoft Windows Server2019

You can download the 7-Zip tool from 7-zip Download page.

Новое action Обновить заголовок окна для обновления имени браузера в
заголовке окна
When you are migrating Enterprise 10 or Enterprise 11 боты that use the Internet Explorer
browser, the Update window title action now converts the window titles of these боты to
Microsoft Edge with IE mode. Заголовки окон обновляются в соответствии с браузером,
который используют боты. For example, consider боты that use Internet Explorer and have
Internet Explorer in the window title. После миграции новое action обновляет заголовок
окна в соответствии с новым браузером Microsoft Edge и форматом текста *Microsoft*Edge.

Использование предыдущих версий веб-действий

Только для Enterprise 11

Автоматизация объектов, появляющихся за окном выполнения бот (ID обращения к
облачному сервису: 00710929)
При запуске бот вы теперь можете автоматизировать объекты, которые появляются за окном
выполнения бот, для следующих команд:
• Распознавание изображений > Поиск окна в окне
• If/Else > Image Recognition > Window is found in window or not
• Мышь > Щелчок
• Распознавание текста (OCR) > Захватить область или окно

Рабочая область RPA

Новые возможности

Поддержка шлюза приложений Azure
On Microsoft Azure cluster environment for On-premises, Azure Application Gateway is now a
supported load balancer..

Поддерживаемые версии компонентов центров обработки данных в Microsoft Azure
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Новые возможности

Установка Bot Agent на устройствах, на которых имеется Enterprise Client Enterprise
11
При создании бот в Automation 360 вы теперь можете установить Bot Agent на устройстве
с существующим Enterprise Client Enterprise 11. Вы можете создавать или запускать боты из
обоих экземпляров Control Room.

Установка Bot Agent и регистрация устройств

Баннер с уведомлением о прекращении поддержки IE 11 в Control Room
Начиная с выпуска Automation 360 v.25, при использовании браузера Microsoft Internet
Explorer для доступа к Control Room вам будет предложено использовать альтернативные
поддерживаемые браузеры, такие как Google Chrome или Microsoft Edge (Chromium). Когда вы
входите в Control Room, отображается баннер с уведомлением о том, что поддержка Internet
Explorer 11 прекращается.

Вход в Automation Anywhere Control Room

Переключение Bot Agent на другую Control Room без переустановки Bot Agent
Теперь вы можете переключать однопользовательское устройство на другую Control Room
без переустановки Bot Agent. Войдите в систему как администратор и установите флажки
Включено и Разрешить быстрое переключение в настройках устройства.

Переключение регистрации устройства между экземплярами Control Room

Configure the VM instance to delay Bot Agent registration
You can now configure the VM instance (golden image) to delay the Bot Agent registration until the
user logs in to the Control Room from that instance. You can also configure up to 20 Control Room
URLs so that you can use the same golden image to connect to any Control Room from that list.
Bulk install Bot Agent on devices

Поддержка Automation 360 для Amazon Linux 2 в окружении EC2 AWS
Automation 360 теперь поддерживает операционную систему Amazon Linux 2 для установки
Automation 360 On-Premises Control Room в окружении Elastic Compute Cloud (EC2) AWS.
Amazon Linux 2

Out-of-sync licenses and Control Room license expiry
When licenses are oversubscribed, the Control Room enters the fail-safe state and continues to
operate in fail-safe mode for 30 days, after which the Control Room becomes locked.
When a Control Room license is within 30 days of expiration, a warning message is displayed in a
banner until the license either expires or is renewed.

Статус безопасного режима Control Room | Уведомления об истечении срока действия лицензии
Control Room

Support for integration with SIEM
The Automation 360 Cloud Control Room now supports integration with security information and
event management (SIEM) to forward the audit logs.

Настройка интеграции с SIEM
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Новые возможности

Enforce coding standards with code analysis
• Code analysis enables you to define and enforce coding standards to improve automation

coding practices. Вы можете установить различные правила, которые будут определять
кодирование. With code analysis, you can implement coding best practices and make the code
more uniform, accessible, reliable, efficient, and secure.

• Two new permissions, View policies and Manage policies, are introduced in the Control
Room for code analysis policy.

Анализ кода

Двухфакторная аутентификация для пользователей Control Room
Если вы администратор Control Room, вы можете включить двухфакторную аутентификацию
(2FA) для пользователей, выполняющих вход в Control Room. Двухфакторная аутентификация
обеспечивает дополнительный уровень безопасности для всех входов в Control Room,
который может быть установлен либо для всех пользователей, либо для пользователей с
определенными функциями.

Двухфакторная аутентификация

Просмотр истории версий зависимостей файлов, не относящихся к бот (ID
обращения к облачному сервису: 01615105)
Теперь вы можете просматривать историю версий зависимостей файлов, не относящихся к
бот. Это помогает определить изменения, внесенные в ваш файл другими пользователями в
определенный день и определенное время, а также просмотреть сообщения о загрузке.
View version history of non-бот file dependencies

Редактирование непустых имен папок в личной рабочей области (ID обращения к
облачному сервису: 00535388, 00730075, 00786633, 00791528, 01615295, 01820406)
Теперь вы можете редактировать непустые имена папок в личной рабочей области.
Благодаря этой функции теперь легче управлять папками. При переименовании папки
проверьте, что выполняются следующие условия.
• Она не содержит выгруженных или клонированных боты даже на уровне вложенных

папок.
• Она содержит не более 100 элементов, включая вложенные папки и файлы.

Создание и переименование папок

Просмотр карт зависимостей для боты
Теперь вы можете просматривать карту зависимостей для вашего бот в общей и личной
рабочих областях. Карта зависимостей показывает непосредственные родительские
и дочерние боты для любого выбранного бот. Если вы разработчик RPA, вы можете
использовать карту зависимостей, чтобы лучше понимать, где вызывается бот и какие
дочерние боты вызываются бот. С помощью этой информации вы можете оценить влияние
изменения в бот, эффективно использовать бот, улучшить код бот и возможность его
повторного использования, а также предотвращать конфликты.
View бот dependency map
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Поддержка автоматизации приложений, поддерживаемых в приложении Citrix
Workspace (ID обращения к облачному сервису: 01758063)
The Citrix Workspace app is now supported on Automation 360. You can now automate applications
that are accessed through the Citrix Workspace app by using the Recorder > Capture action or
the Start recording option.

AISense Recorder.Поддержка корейского языка и сложных операций с таблицами
• Теперь можно использовать AISense Recorder для автоматизации приложений,

использующих корейский язык и сочетание корейского и английского интерфейсов.
AISense для записи задач из удаленных приложений

• С помощью AISense Recorder теперь можно извлекать табличные данные из сложных
таблиц. Вы можете записывать и автоматизировать таблицы с более широкими столбцами
и таблицы, в которых есть столбцы с элементами управления, такими как флажки или
параметры. Вы также можете извлекать определенные столбцы из таблиц.

Прим.:  Если таблица не распознается автоматически, воспользуйтесь параметром
Определить для обнаружения таблицы.

Table data extraction through AISense Recorder

Усовершенствования Средство записи
• При запуске бот теперь можно автоматизировать объекты, которые появляются за

окном выполнения бот, с помощью action Средство записи > Запись. (ID обращения к
облачному сервису: 00684306, 00770636, 01146672)

• Теперь вы можете использовать Средство записи для записи и автоматизации объектов с
определенной технологией. Теперь на вкладке Сделать снимок объекта есть параметр
для выбора конкретной технологии и записи с использованием этой технологии. Вы
можете записывать объекты с помощью следующих технологий:
• Microsoft Active Accessibility (MSAA)
• UI automation
• Microsoft (MS) COM UI Automation

Capture using specific technology

(ID обращения к облачному сервису: 01760871, 01865823
• You can now use the Средство записи to automate third-party plug-in window objects on

Google Chrome or Microsoft Edge browsers by using a specific technology.

Параметр Уменьшить потерю данных в пакет PDF
В action PDF > Извлечь текст для поля типа Структурированный текст теперь доступен
новый параметр Уменьшить потерю данных. При использовании этого параметра вы
можете извлечь полный текст с минимальным перекрытием символов.
Using Extract text action from PDF
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Усовершенствования пакет Строка (ID обращения к облачному сервису: 00770822)
В action Строка > Извлечь текст теперь доступен новый параметр При извлечении. Вы
можете использовать этот параметр, чтобы указать, должен ли регистр текста в извлеченной
подстроке совпадать с регистром исходной строки.
Using Extract text action of Строка пакет

Загрузка файлов с URL-адресов, требующих аутентификации NTLM (ID обращения к
облачному сервису: 01189873)
С помощью улучшенного пакет Браузер теперь можно загружать файлы с URL-адресов,
требующих аутентификации NTLM, с помощью action Браузер > Загрузить файл.

New option in Connect action of the Эмулятор терминала пакет (Service Cloud case ID:
00812730, 01252363, 01804623)
You can now edit the screen of the Эмулятор терминала session manually by selecting the Set
cursor position to the beginning check box. By selecting this option, you can now set the focus
to the first editable field. By default, this option is not selected.

Массовое обновление до версии пакет по умолчанию для всех боты (ID обращения к
облачному сервису: 00712719, 00728499, 00737694, 00803673, 01255722, 00838604, 00772147,
01760236, 01762679, 01771416, 01761859, 01782588, 01778220, 01784255, 01789551,
01809167, 01818690)
Use Update bots to default package version to update боты to use the default version for any
пакет. User with the View Packages and the permission to edit the боты can now update боты
in bulk to use the default пакет version. This feature provides you with an efficient way to securely
update all the боты in the Control Room repository that you have access to with the default пакет
version in a few clicks.

Обновление боты до версии пакет по умолчанию | Example of updating default пакет version across
боты

Advanced search feature in the Bot editor  (Service Cloud case ID: 01615310, 01780115)
Помощник по созданию ботов теперь включает в себя функции Расширенный
поиск для улучшения общего процесса поиска в Bot editor. Это помогает повысить
производительность Bot Creator. Страница Расширенный поиск позволяет вводить
искомый текст, выбирать критерии фильтрации результатов поиска и перемещаться по
результатам поиска. Вы можете использовать критерии фильтрации, чтобы сузить область
поиска и быстро найти искомый текст. Когда вы редактируете или просматриваете бот, вы
можете использовать функцию расширенного поиска, чтобы найти точную строку action и
соответствующие сведения о action, в которой появляется искомый текст, то есть строку,
текстовое значение или имя переменной.

Прим.:  Find in this bot is now renamed to Search in this bot.

Advanced search option in Bot editor
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Усовершенствование параметра нескольких вложений в action «Отправить
сообщение эл. почты» (ID обращения к облачному сервису: 00800976, 00817136,
00821405, 00936080, 01256523, 01256320, 01262069, 01259369, 00936080, 01801928)
При отправке сообщений электронной почты из боты теперь можно отправлять несколько
вложений в виде списка файлов или переменной, содержащей список объектов файлов. С
помощью этой функции вы можете прикреплять к сообщениям электронной почты такие
файлы, как файлы данных, электронные таблицы и документы текстовых редакторов.
Можно прикреплять несколько путей к файлам на локальном или сетевом диске, а также
использовать переменную, содержащую путь к файлам.
Using the Send action

Усовершенствование пакет Веб-служба SOAP
Когда вы создаете ответ SOAP для выражения Xpath в пакет Веб-служба SOAP, результат
выражения Xpath может быть сохранен в виде списка строк.

Пример использования действия веб-службы SOAP

Поддержка обобщенных табличных выражений в action «Экспортировать в
таблицу данных» (ID обращения к облачному сервису: 00655318)
Теперь вы можете упростить сложные соединения и подзапросы, используя обобщенные
табличные выражения (CTE) в совместимых с SQL базах данных. Используйте CTE в action
Экспортировать в таблицу данных в пакет База данных с помощью ключевого слова
WITH.

Усовершенствование пакет Распознавание текста (OCR)
Когда вы используете actions из пакет Распознавание текста (OCR), например Захватить
область или Захватить окно, бот теперь распознает элементы управления, даже если они
находятся за окном выполнения бот. Он также извлекает текст за окном выполнения бот
Automation 360 из любого окна приложения.

New пакет SDK version
You can now set up the default value for a global session by using default_session_value in
CommandPkg in the newly released пакет SDK version.

Настройка пакеты для On-Premises
On-Premises administrators can now disable the latest пакет version from becoming the default
version automatically. Administrators can also enable a feature that fetches and installs new пакет
versions as and when they are released even without a Control Room upgrade.

Автоматические обновления пакет для On-Premises Control Room

Автоматизация рабочих нагрузок, поддерживаемая для баз данных PostgreSQL и
Oracle
Автоматизация рабочих нагрузок теперь поддерживается для баз данных PostgreSQL и Oracle.
Все автоматизации рабочих нагрузок отлично работают с обеими базами данных.

Управление рабочей нагрузкой
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API триггеров
Map triggers to users or roles for an attended Bot Runner user by using the Trigger API. С
помощью API-интерфейса триггеров вы также можете создавать и удалять триггеры событий.
API триггеров

Enhancement to the Authentication using apikey
With .24 or previous versions, you must replace any escape character '\' with '\\' in the API key.
With .25 or later versions, the API key will no longer have any escape characters('\').

Newly implemented Activity List API
With the newly implemented Activity List API (v3/activity/list) you can return the job
executions without call back and бот output information. The old Activity List API (v2/activity/
list) is now deprecated.
v3/activity/listBot Execution Orchestrator API

Definition:  Deprecation refers to features or capabilities available in the current (latest) release
that will be removed or unsupported from a future release.
You can use the specified alternatives or updated versions when they are made available.

Migrate from Enterprise 11 Control Room version 11.3.4.7 to Automation 360 On-
Premises
We now support migrating from Enterprise 11 Control Room version 11.3.4.7 to Automation 360
On-Premises v.25 and later releases.

Поддерживаемые для миграции версии Control Room

Изменения

Усовершенствование пакета Строка (ID обращения к облачному сервису: 00770822)
Когда после миграции боты вы извлекаете текстовую строку на основе исходной строки,
регистр строки по умолчанию не совпадает с регистром исходной строки. Для новых боты
регистр строки по умолчанию совпадает с регистром исходной строки.

Enhancement to the Браузер package
In Enterprise 11, if a бот is using the Launch Website action to open a URL in Internet Explorer and
when migrating the бот to Automation 360, if you select the Convert bots built using Internet
Explorer to Edge with Internet Explorer mode option in the Settings panel of the Bot
Migration Wizard, the URL is automatically set to open in Microsoft Edge after migration.

Параметр изменения местоположения глобального кэша (ID обращения к облачному
сервису: 00745395, 00781135,00831182, 01124360, 01764952)
Как администратор, вы теперь можете изменить местоположение по умолчанию для
глобального кэша в соответствии с вашими потребностями в разделе Администрирование
> Настройки > Устройства > Расширенные параметры.
Manage device settings
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Усовершенствование сервера базы данных для экземпляра Control Room
Чтобы настроить подключение и аутентификацию для сервера базы данных, используйте
номер порта экземпляра сервера базы данных (номер порта по умолчанию — 1433) вместо
имени экземпляра.
Configure Microsoft database type and server

Для изменения учетных данных пользователя добавьте новую конфигурацию для
настроек LDAP, не вызывая сбой выполняемой аутентификации
При изменении или обновлении учетных данных пользователя теперь открывается страница
настроек LDAP, чтобы администратор Control Room мог добавить новую конфигурацию
настроек LDAP, не вызывая сбой выполняемой аутентификации.

Поддержка точного совпадения в поле темы для триггеров электронной почты (ID
обращения к облачному сервису: 00953823)
Когда вы подключаете Control Room к одной из служб электронной почты в вашей системе
и запускаете триггер бот при получении нового сообщения электронной почты, триггер
электронной почты теперь срабатывает в зависимости от следующих условий темы.
• Если тема письма заключена в двойные кавычки (""), например "электронная таблица

ABC", триггер срабатывает только в том случае, если тема сообщения имеет точное
совпадение со строкой, заключенной в кавычки.

• Если несколько строк темы разделены точкой с запятой, например электронная
таблица ABC; журналы проекта ABC, триггер срабатывает, когда тема сообщения
совпадает с любой из указанных тем.

Импорт боты Enterprise 11 с MetaBots или без них (ID обращения к облачному сервису:
01261325)
Теперь вы можете импортировать боты Enterprise 11 (файл .aapkg) с зависимыми MetaBots
или без них в общую рабочую область. Если вы импортируете файл .aapkg в личную рабочую
область, проверьте, что зависимые MetaBots включены.

Summary of changes in пакеты

The following table summarizes the new and updated features in the Control Room пакеты:

Name of пакет or
action

New or changed
feature

Номер версии Версия бот-агента

AISense Recorder Support for Korean
language and complex
table operations

Корейский язык и
поддержка сложных
таблиц

2.7.3-20220527-004608 21.210 or later
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Name of пакет or
action

New or changed
feature

Номер версии Версия бот-агента

Браузер пакет Support to download
files from URLs
that require NTLM
authentication

Аутентификация NTLM

3.5.1-20220527-172031 21.210 or later

База данных пакет Support for common
table expression in
Export to data table
action

Поддержка CTE в
действии «Экспорт в
таблицу данных»

4.8.0-20220504-130202 21.88 or later

Эл. почта пакет Support for sending
mail with multiple
attachments through
боты
Send email with multiple
attachments

3.12.3-20220516-11485421.210 or later

Распознавание текста
(OCR) пакет

Support to identify and
capture controls behind
бот runtime window
Support to capture
controls that appear
behind the runtime
window

2.10.0-20220502-20431821.118 or later

PDF пакет Support to extract
complete text with
minimal overlap of
characters

Точное извлечение
текста

3.5.2-20220414-101844 21.31 or later
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Name of пакет or
action

New or changed
feature

Номер версии Версия бот-агента

Средство записи • Support to automate
objects that appear
behind бот runtime
window

Автоматизация
объектов за окном
выполнения бота

• Support to automate
objects with specific
technology

Автоматизация
объектов со
специальной
технологией

• Support to automate
applications
accessed through
Citrix Workspace
app

Автоматизация
приложений с
доступом через
приложение Citrix
Workspace

2.7.3-20220527-004608 21.210 or later

Веб-служба SOAP
пакет

Support to store output
of Xpath expression as
list of strings

Хранение вывода
выражения Xpath в
виде списка строк

3.11.3-20220426-06442321.90 or later

Строка пакет Support to match case
of text in extracted
substring to that in
source string
Match case of substring to
that of source string

5.4.2-20220412-134724 20.18 or later

Важное замечание:  For information about the packages supported with this release, see also View
пакет versions available in the Control Room.
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Сборка ID обращения к
облачному сервису

Описание

15112 01838276, 01835897 When you update to Automation 360 v.25, an error no
longer occurs when the database server includes the
instance name.

Builds 14304 and
15112

01834139,
01839933,
01841993,
01839817,
01834108,
01846407,
01845706,
01843349,
01846220,
01846819,
01845547,
01847028,
01847024,
01847094,
01847114,
01847115,
01846998,
01847840,
01846757,
01848123,
01846944,
01848104,
01848294,
01848905,
01846596, 01849748

When you successfully export a бот, the latest бот
export activity is now displayed on the Historical
activity page. Previously, the latest export event was
not displayed as the Ended on column was displaying
the value as N/A.

Builds 14304 and
15112

01836296 When you delete a user or a role, only one entry
is now generated for each action in the audit log.
Previously, multiple duplicate audit log entries were
generated for a single action, affecting the user
management workflows.
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Сборка ID обращения к
облачному сервису

Описание

Build 14304 and
15112

01842547,
01846156,
01847338,
01846324,
1842368, 01847054,
01848080,
01848789,
01848151,
01848963,
01847054,
01847121,
01848236,
01848260,
01849016,
01848248,
01848572,
01847828,
01847055,01848826,
01848191,
01848944,01851181,
01849792, 01852057

When you use the Wait > Wait for condition action
with conditions that have specific timeout values set,
the бот now waits only for the specified waiting time
then runs the subsequent action. Previously, even
when you specified a timeout value, the бот waited
indefinitely.

15097 01274643, 01812436 Если у вас есть функция в DLL, которая использует
переменную учетных данных в качестве входного
параметра, и если переменная учетных данных
недоступна в Automation 360, вы увидите
сообщение A108 о миграции. Раньше вы видели
сообщение E153 о миграции.

Сообщения при выполнении миграции

15097 -- Теперь вы можете выполнять миграцию боты, даже
если дата и месяц для параметров Изменено
до и Изменено между в action Файл и папка
представляют собой одно- или двузначное число,
а год — одно-, двух- или четырехзначное число.
Ранее перед переносом боты необходимо было
указать даты в формате ММ/ДД/ГГ.

15097 01260742 Когда после миграции система передает Значение
учетных данных (CV) типа «переменная»
от родительского бот к переменной не-CV
логики MetaBot, временная переменная типа
«строка», которая создается для хранения CV,
теперь не превышает 50 символов или включает
недопустимый символ пробела.
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15097 00796546 Утилита предварительной миграции Bot Insight
теперь может устранять идентификаторы
поврежденных информационных панелей, которые
присутствуют в таблицах BI, и генерировать
файл dashboards.zip для миграции. Ранее, когда
в таблицах BI обнаруживались идентификаторы
поврежденных информационных панелей, утилита
предварительной миграции Bot Insight выдавала
ошибку и закрывалась.

15097 01758427, 01805913 В приложении SAP, когда вы используете элемент
управления Щелчок, вкладки теперь выбираются
должным образом.

Прим.:  Значение Тип в Enterprise 11 было
переименовано в Функция в Automation 360.

Когда вы выполняете миграцию с Enterprise 11 на
Automation 360, в поле Функция автоматически
устанавливается значение из раздела Тип
элемента управления SAP в поле Подтип,
если в поле Тип в Enterprise 11 было установлено
значение GuiShell. Например, если в Enterprise
11 в поле Тип было установлено значение
GuiShell, а в поле Подтип было установлено
значение Табличный вид, в Automation 360 в
поле Функция автоматически устанавливается
значение Табличный вид.

15097 01376353,
01449535,
01713118,
01627144, 01762404

Теперь при обновлении Control Room с Automation
360 v.21 или v.22 до Automation 360 v.23 или v.25
установка завершается успешно без каких-либо
проблем. Ранее происходил сбой установки, когда
пользователи, создавшие расписания миграции,
теряли разрешения после миграции.

15097 01257547,
01722892,
01291187,
01770716, 01777450

Теперь вы можете редактировать или удалять
расписания, поскольку вы больше не можете
удалить файл .atmx, связанный с расписанием, из
Automation 360 Control Room. Ранее файл .atmx мог
быть удален, что приводило к ошибке, которая не
позволяла редактировать или удалять расписание.

15097 01255723,
01252824,
01260677, 01608653

Когда вы переносите боты Enterprise 11 с
включенной командой Комментарий, эта команда
остается включенной после миграции.

Прим.:  Если команда Комментарий содержит
переменную или символ $, команда отключается
после миграции.
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15097 01755175 Теперь вы можете переносить боты с системными
переменными (например, датой, месяцем или
годом) с помощью параметра Экспорт данных в
CSV без ошибок.
Ранее в таких случаях отображалась ошибка
предварительной обработки.

15097 01261863 Теперь вы можете переносить боты с системными
переменными или выражениями, которые содержат
переменные массива, без ошибок. Ранее в таких
случаях возникала ошибка предварительной
обработки.

15097 01758814 You can now migrate боты when the MetaBots Логика
call each other and another, third Логика calls one of
these in recursion. Ранее в таких случаях миграция
бот завершалась сбоем с сообщением «Произошла
непредвиденная ошибка».

15097 01255810 Если вы выполняете действие Отправить текст
дважды для одного и того же значения в Эмулятор
терминала и первое поле защищено, когда экран
Эмулятор терминала загружается во второй раз, он
корректно работает после миграции.
Ранее при загрузке экрана Эмулятор терминала во
второй раз наблюдалось некорректное поведение.

15097 01770547 В командах Automation 360 выражения, в которых
переменная заключена в круглые скобки и перед
ней стоит символ $, теперь переносятся правильно,
при этом перед переменной внутри круглых скобок
и после нее ставится символ $.

15097 01258964 После миграции action Запись теперь может
распознавать всплывающие окна, которые
используют тот же заголовок, что и главное
окно, в SAP GUI. Ранее action Запись не могло
распознавать всплывающие окна, которые
используют тот же заголовок, что и главное окно.

15097 00745395,
00781135,
00831182,
01124360, 01764952

Если длина пути к глобальному кэшу превышает
256 символов, Automation 360 автоматически
меняет путь на местоположение по умолчанию.
Однако в пользовательском интерфейсе
отображается путь, заданный пользователем.
Ранее, когда длина пути к глобальному кэшу
превышала 256 символов, в Automation 360 при
загрузке пакеты отображалась ошибка.
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15097 01767018,
01755092,
01765551,
01764245,
01778477,
01782790, 01795043

Если у пользователя нет разрешения на доступ
к триггеру или папке с триггером на вкладке
«Общие», на странице триггеров событий теперь
не отображается сообщение об ошибке. Ранее,
если у пользователя не было разрешения на
доступ, на странице триггеров событий для этого
пользователя отображалась ошибка на вкладке
«Общие».

15097 01765445,01759831,
01779960, 01799422

When you log in to the Control Room as an
administrator, you can no longer delete users that
have active schedules.

15097 01255678 На странице Управление > Устройства в
столбце Кем изменено теперь правильно
отображается имя последнего пользователя,
изменившего сведения. Например, если
пользователь 1 регистрирует устройство, а затем
пользователь 2 изменяет сведения об устройстве,
например Тип развертывания, то вместо
имени пользователя 1 в столбце Кем изменено
отображается имя пользователя 2.

15097 -- При установке Control Room (On-Premises), даже
если настроено внешнее хранилище ключей,
теперь можно вручную ввести учетные данные
базы данных и настроить их для аутентификации
базы данных на странице Сервер базы данных
установщика Windows.

15097 01753671 После обновления до этого выпуска на странице
Просмотреть историю TaskBot в столбцах
Загружен и Загружен пользователем теперь
отображается правильная информация.

15097 -- Now when you run боты that have the Get Total
Rows command in the SAP GUI, the values are
returned as Integer data type. Ранее такие команды
возвращали значения в виде типа строки Float.

15097 01212822 При автоматизации рабочей нагрузки теперь
можно просматривать и использовать очереди,
даже если имя шаблона рабочей операции
содержит начальные или конечные пробелы. Хотя
пробелы отображаются в имени очереди, они
автоматически удаляются при создании шаблона
рабочей операции. Кроме того, пробелы в начале
или конце имен очередей игнорируются во время
выполнения. Ранее имена очередей и шаблонов с
пробелами в начале или конце не отображались и,
соответственно, были недоступны для выбора.
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15097 01772061 После обновления до этого выпуска Automation
360 больше не позволяет одновременно
выполнять несколько заданий синхронизации
лицензий. Ранее, когда выполнялось несколько
заданий синхронизации лицензий, в журналах
аудита отображались ошибки Лицензии
синхронизированы.

15097 01754415 When you update from Automation 360 v.21 or
later, the Bot Agent devices are no longer shown
as disconnected in the Control Room Manage >
Devices page. When you try to update Bot Agent in
versions prior to Automation 360 v.21, a message now
indicates that the device is not compatible.

15097 01780460 После обновления до этого выпуска
Расширенные параметры Control Room
для устройств (Администрирование >
Настройки > Устройства), например Время
ожидания автоматического входа в систему,
Максимальное количество одновременных
загрузок и Время ожидания ответа бота,
больше не сбрасываются до значений по
умолчанию.
Например, если вы зададите для параметра Время
ожидания автоматического входа в систему
значение «70», после обновления до этого выпуска
значение останется равным 70 и не сбросится до
значения по умолчанию.
Ранее при обновлении Control Room, например
с Automation 360 v.22 до Automation 360 v.23,
Расширенные параметры для устройств
сбрасывались до значений по умолчанию.

15097 01762582,
01808698, 01815446

На странице Control Room Действия теперь
корректно отображается общее количество
запланированных действий. Ранее, если количество
запланированных действий превышало 200, на
странице Control Room Действия отображалось
только 200 действий и приходилось сортировать
их по столбцам Имя действия, Приоритет
автоматизации или Кем изменено, чтобы
увидеть правильное количество запланированных
действий.

15097 01764492 Когда вы устанавливаете Automation 360 Control
Room, созданный установщиком файл журнала
больше не отображает пароль открытым текстом.
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15097 -- Если на странице Администрирование >
Настройки > Электронная почта не выбран
параметр Требуется проверка, вы больше не
получите ссылку в уведомлении по электронной
почте, чтобы подтвердить себя как пользователя.
Теперь вы можете выполнить вход в Control Room
без проверки идентификатора электронной почты
и настройки учетных данных для входа. Ранее
отправлялось уведомление по электронной почте
со ссылкой для подтверждения адреса электронной
почты, даже если вы не выбирали параметр
Требуется проверка.

15097 01783110 Если во время бот произойдет сбой бот, то теперь
на странице Действия > История в Control Room
отображается правильное время Начато (то есть
время, когда запущен бот). Ранее, когда запуск
бот не удавался, время Начато отображалось
неправильно, когда происходил сбой бот. В
результате в столбцах Начато и Завершено
отображалось одинаковое время, что было
неправильно и сбивало с толку.

15097 01826944, 01828683 When you log in to the Control Room, the Activity
> Historical page now loads without error. For the
historical data in the JOBEXECUTION table, a new
Cloud data retention policy of 90 days is implemented,
whereby the Cloud historical data is deleted along
with the rollout of Automation 360 v.25 to the
different regions. Previously, when you logged in to
the Control Room, the Activity > Historical page
did not load because of a large number of records,
and the following error message was displayed: An
unexpected problem has occurred

• Просмотр выполненных действий
• Automation 360 Cloud FAQ

15097 01753337, 01785865 Когда на странице Действия > В процессе
выполнения вы используете функцию
сортировки, чтобы отобразить элементы в столбце
Начато в порядке возрастания или убывания,
теперь элементы распределяются правильно.

15097 -- Теперь вы можете установить безопасное
подключение SQL в среде Linux, выбрав параметр
Включить в поле Конфигурация базы данных
> Безопасная конфигурация > Безопасное
подключение. Теперь установщик Linux успешно
импортирует сертификат SSL, и соединение
устанавливается. Ранее установщик Linux не мог
импортировать сертификат SSL, и соединение не
устанавливалось.

© 2023 Automation Anywhere. All rights reserved.     235



    Automation Anywhere - Learn

Исправления

Сборка ID обращения к
облачному сервису

Описание

15097 00781974 В среде Linux службы больше не будут
останавливаться из-за проблемы с местом на
диске. Ранее некоторые сообщения журнала Control
Room хранились в файле /var/log/messages (а
не в каталоге /var/log/automationanywhere), что
приводило к нехватке места на диске.

15097 01260701 При запуске боты на пользовательских устройствах
боты больше не застревают в очередях. Кроме
того, больше не отображаются следующие
сообщения:
• Ожидание пользователя username
• Выбирается во время выполнения

15097 01760032 Имена доменов больше не учитывают регистр, и
теперь можно создавать пользователей с помощью
сопоставления групп Active Directory и сопоставить
функцию с пользователем в Control Room. Ранее,
поскольку некоторые серверы Active Directory
возвращали имена доменов в верхнем регистре,
а другие — в нижнем, не удавалось найти имена
доменов и возникали проблемы с функцией
сопоставления групп.

15097 00828289 The Global Value fields are now validated and have a
maximum length of 4000 characters.

15097 00828289 When you navigate to My settings >
My Profile > Edit in the Control Room
and provide a link, for example, <a
 href="www.google.com">LinkInjection</
a>, the email sent contains a link, and the email text
sent is validated against HTML injection and you will
no longer see a functional link.

15097 01754431,
01773662,
01789555,
01791065,
01784255,
01785653, 01780070

При использовании Средство записи для
захвата объекта, если вы устанавливаете для
времени ожидания обнаружения объекта в поле
Продолжайте попытки в течение (секунд)
значение менее 30 секунд и запускаете бот,
Средство записи теперь ожидает обнаружения
объекта в течение указанного времени и ждет
полной загрузки страницы. Ранее Средство записи
ожидал обнаружения объекта в течение минимум
30 секунд независимо от указанного времени.

Прим.:  Это исправление относится только
к браузерам Google Chrome и Microsoft Edge
Chromium.
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15097 01614810 Теперь можно использовать пробел в качестве
разделителя в поле Указать разделитель
(необязательно). В action Открыть в пакет
CSV/TXT, когда вы вводите путь к файлу, чтобы
открыть файл, добавляете пробел в качестве
разделителя в поле Указать разделитель
(необязательно) и запускаете бот, пробел теперь
корректно распознается как разделитель и запуск
бот больше не завершается сбоем.

15097 01387738 Когда вы используете action Браузер > Открыть
для открытия нового окна в Google Chrome, новое
окно теперь активируется и отображается поверх
других открытых окон. Ранее, когда вы запускали
бот, окно оставалось свернутым.

15097 01273095 Если при вводе десятичного значения с 16
или более десятичными знаками в одной
ячейке электронной таблицы Microsoft Excel вы
используете функцию Прочитать значение
ячейки в разделе Расширенный Excel >
Получить одну ячейку, actions Получить
несколько ячеек или Получить лист
как таблицу данных для извлечения
десятичного значения из ячейки, формат
значения ячейки больше не меняется с Общий на
Экспоненциальный.

15097 01144509, 01767881 Когда вы подключаетесь к сеансу SAP, используете
условие Средство записи Если > Объект
существует для идентификации и захвата
объектов в приложении SAP, отключаетесь от
сеанса SAP, а затем выполняете эти actions в цикле,
бот теперь корректно распознает объекты в каждой
итерации цикла. Ранее, когда бот работал в цикле,
он правильно захватывал объекты только во время
первой итерации и выдавал ошибку во время
последующих итераций.

15097 01769573 Если вы используете action Интеграция
приложений > Получить текст из окна для
захвата текста в окне командной строки, когда вы
запускаете бот, бот теперь правильно захватывает
все символы в каждой строке. Ранее бот не
захватывал последние символы в каждой строке.
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15097 01628448,
01766957,
01788709,
01788801,
01789538,
01803156,
01781597,
01810230,
01811694,
01802054,
01815687,
01823526,01814962,
01833962,
01835418,
01835382,
01837832,01830790

Теперь пакет Расширенный Excel работает
должным образом и без каких-либо проблем. Ранее
пакет периодически отображал ошибку общего
исключения.

15097 00824995,
01451063, 01274854

В action PDF > Извлечь поле, когда вы выбираете
параметр Открыть средство просмотра
PDF-файлов, выбираете PDF-файл из Control
Room или c рабочего стола, щелкаете Загрузить
и открываете средство просмотра PDF-файлов,
вы теперь можете просматривать PDF-документ.
Ранее при выборе параметра Открыть средство
просмотра PDF-файлов для просмотра
выбранного PDF-документа отображалась пустая
страница и значение в PDF-документе можно
было увидеть, только выделив определенную
прямоугольную область в пустом поле.

15097 00957308 Если при выполнении action Файл > Копировать
файл рабочего стола вы указываете путь к
исходному файлу, в котором имя папки содержит
знак номера (#) или имя файла содержит
символ подстановки, указываете целевой путь
для копирования файла и запускаете бот, бот
теперь успешно определяет путь к исходному
файлу и копирует файл в указанное место
назначения. Ранее, когда вы запускали бот, бот не
удавалось определить путь к исходному файлу и,
соответственно, файл не копировался в целевую
папку.

15097 01685239 Теперь вы можете использовать Средство
записи для записи объектов в приложении Citrix
Xenapp. Используйте условие Если > Объект
не существует, чтобы проверить, существует
ли определенный объект в приложении, а также
запускайте бот из родительского бот. Ранее при
попытке это сделать возникала ошибка.
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15097 01260387 A password-protected Microsoft Excel file is no longer
corrupted when you open the file manually after
successfully running a бот using the Базовый Excel
пакет. Previously, when you used the actions in the
Базовый Excel пакет to open a password-protected
Excel file, made some updates to the file, and closed
the file by selecting Save changes when closing
file in the Excel basic > Close action, the password-
protected Excel file became corrupted when you
opened it manually from its location.

15097 00920617 Когда вы подключаетесь к своему почтовому ящику
по протоколу IMAP, используйте Для каждого
сообщения в почтовом ящике в качестве
итератора почтового цикла для извлечения всех
сообщений, полученных до даты фильтра, и
запустите бот. Теперь бот извлекает все сообщения
электронной почты, полученные до указанной
даты, включая сообщения, полученные в заданный
день до указанного времени.

15097 -- Теперь в Google Chrome, Microsoft Edge и Mozilla
Firefox можно открывать сетевые URL-адреса,
начинающиеся с двух символов обратной косой
черты (\), с помощью action Браузер > Открыть.

15097 01015001 Когда вы указываете общее количество пакеты,
которые вы хотите просмотреть на странице в
разделе Управление > Пакет в Control Room,
на странице теперь отображается правильное
количество указанных пакеты. Ранее все пакеты
отображались на одной странице, даже если вы
выбирали для просмотра только определенное
количество пакеты.

15097 01711629 Если в action Средство записи > Запись вы
выбираете определенное окно браузера, название
которого совпадает с названием другого окна
браузера со вкладки Браузер и запускаете бот, то
бот теперь открывает выбранное окно браузера.
Ранее, когда название двух окон браузера
совпадало, бот случайным образом открывал окно
браузера с совпадающим названием.

15097 -- Теперь вы можете использовать action Браузер
> Выполнить JavaScript для успешного
выполнения JavaScript на веб-страницах,
содержащих iFrame.

15097 01075660, 01273111 actions Расширенный Excel > Открыть и
Создать книгу теперь отображают значение
сеанса По умолчанию в поле Локальный сеанс.
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15097 01252773,
01278029,
01772301, 01765017

An error no longer occurs when you use the Excel
advanced > Open action to open a worksheet that is
a type of hidden chart or a macro. You can specify the
sheet name to open the worksheet of type macro.

Прим.:  When you open the default sheet, ensure
that the active sheet is an Excel Worksheet. If the
active sheet is of type chart, the following error
message is now displayed: The Excel file does
not contain an active sheet to open.
Please make sure the Excel file you want
to open has at least one active sheet.

15097 -- After migration, when you run the боты that use Файл
и папка пакеты, the year under the Date option now
accepts the value 00 as input, which is considered as
year 2000.

15097 01257829 В actions пакет Веб-службы REST теперь можно
добавить тип содержимого Custom, с помощью
которого можно добавлять содержимое, которое не
относится к стандартному типу содержимого.

15097 -- В actions пакет Веб-службы REST теперь
можно выполнить действие Добавить замену, с
помощью которого можно вводить переменные в
тело запроса REST.

15097 01784553, 01794924 В actions пакет Веб-служба SOAP символ
амперсанда (&) теперь автоматически
экранируется. Ранее символ амперсанда
(&), который является зарезервированным
управляющим символом, не экранировался
автоматически, что приводило к появлению
недействительных XML-файлов.

15097 01767571 В actions пакет Веб-службы REST новые строки
в теле запроса больше не изменяются во время
выполнения. Например, если тело запроса
содержит новую строку, она больше не заменяется
пробелом во время выполнения. Ранее, когда тело
запроса содержало новую строку, она заменялась
пробелом.

15097 00773353, 00787270 In the REST Web Services пакет actions, you can
now use the user token option to access the Control
Room APIs. When you log in to the Control Room, a
token is generated, which is used by the бот to access
the endpoints of the Control Room API used within the
бот.
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15097 01372460 Теперь можно запускать боты с помощью action
RunScript из пакет Legacy Automation. Когда
вы передаете несколько аргументов для замены
значений из документа Microsoft Word, бот теперь
выполняет функцию, заменяет и отображает текст
в новой строке. Ранее текст отображался в той же
строке.

15097 01758458 When you use the Connect action to establish a
connection with an email server, use the Disconnect
action to close the connection with the same session
name. You will then not encounter any issue when you
establish a new connection again with the same or
different credentials.

15097 01273357 При создании бот для запуска стандартного
рабочего процесса в SAP BAPI выходные данные
теперь корректно генерируются в виде файла .CSV.
Ранее при запуске стандартного рабочего процесса
в SAP BAPI выходные данные генерировались в
разных форматах.

15097 01342887 Когда вы запускаете процесс с помощью пакет
Эмулятор терминала, окно терминала теперь
активируется и отображается поверх остальных
окон. Ранее, когда вы запускали процесс, окно
терминала не активировалось и оставалось
свернутым.

15097 01251933 В пакет Эмулятор терминала, когда вы используете
действие Подключить для установления
соединения с TN3270E, ошибка больше не
возникает. Previously, an error occurred, and
the following error message was displayed on the
mainframe screen: ISPP904 Ошибка панели
ISR@PRIM - x'0E' или x'0F’ недопустимы в
качестве символа атрибута

15097 01432885 Когда вы запускаете бот, в поле измерения
Количество запущенных Task Bot на
Главной странице информационной панели
Control Room теперь отображается правильное
количество. Ранее в поле измерения отображалось
неправильное количество. Например, если на
Главной странице информационной панели
в поле Количество запущенных Task Bot
отображалось 39, то при запуске бот вместо 40
отображалось 42.

15097 00742840 Когда вы используете actions, например Открыть
и Выполнить функцию, из пакет DLL, больше
не возникают ошибки. бот теперь открывает файл
DLL, даже если длина пути к файлу DLL меньше 256
символов.
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15097 01261786, 01615115 Когда вы редактируете бот и выключаете action
внутри него, вы теперь можете использовать
сочетание клавиш Ctrl+Z, чтобы отменить action.
Ранее сочетание клавиш Ctrl+Z не работало
должным образом.

15097 01080067 В пакет Active Directory, когда вы используете
имена пользователей со специальными символами,
бот теперь работает корректно. Ранее, когда
вы добавляли пользователя в группу, если имя
пользователя содержало специальные символы,
при попытке удалить пользователя из группы бот
выдавал ошибку.

15097 00962414 При подключении к приложению puTTY через
Эмулятор терминала больше не возникает проблем.
Ранее при подключении терминала к узлу узел
запрашивал пароль. После этого экран терминала
выключался и бот выдавал следующую ошибку:
Не удается подключиться к терминалу.
Проверьте данные подключения

15097 00829259 В Active Directory теперь можно успешно создавать
пользователей с одним из следующих параметров:
Потребовать смены пароля при следующем
входе в систему или Не требовать смены
пароля при следующем входе в систему.
Ранее, когда вы использовали action Подключить
для установки соединения, если путь подключения
LDAP содержал атрибут OU с пробелом, например
OU=aa unit, при запуске бот возникала ошибка.

15097 00961069 When you are using the Send text action from the
Эмулятор терминала пакет, you can now send
numeric keyboard minus (-) keys with Alt+- (Alt
+hyphen) keys to the mainframe application.

15097 00825675 Когда вы удаляете сопоставление переменных
из родительских и дочерних боты и затем
запускаете родительский бот, бот больше
не выдает ошибку. Ранее, когда вы удаляли
сопоставление переменных из родительских и
дочерних боты и затем запускали родительский
бот, бот выдавал ошибку.

15097 00798604 Когда вы используете action Выполнить
функцию из пакет VBScript, бот больше не
выдает ошибку. Теперь вы можете указать имя
функции для запуска и передачи аргументов,
содержащих скобки ([]). Ранее при выполнении
action Выполнить функцию возникала ошибка,
если параметр строки содержал открывающую или
закрывающую скобку.
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15097 -- Если при использовании файла DLL, который
доступен в Control Room, путь к файлу DLL
содержит менее 260 символов, бот теперь успешно
извлекает файл DLL.

15097 01149730 Теперь вы можете подключиться к серверу
электронной почты, выбрать протокол IMAP,
использовать итератор Цикл > Для каждого
сообщения в почтовом ящике, а также
загрузить вложения из сообщения электронной
почты и сохранить их в указанной папке. Ранее,
если у вложений был файл bin, вложения не
загружались и не сохранялись в папке.

15097 00919896 Когда вы используете actions (например,
Отправить текст или Отправить ключ) из
пакет Эмулятор терминала, программа запуска
бота больше не перестает работать. Ранее
боты, созданные с помощью actions из пакет
Эмулятор терминала, иногда переставали
работать в случайном порядке, когда был включен
двухбайтовый набор символов (DBCS), а на экране
хоста имелось поле с сопоставлением.

15097 00950682 Теперь вы можете использовать action Открыть
электронную таблицу в пакет Google Таблицы
без каких-либо проблем, даже если вы используете
файл автоматической настройки прокси-сервера
(PAC) или среду с поддержкой прокси.

15097 01257464 Когда вы подключаетесь к серверу электронной
почты с помощью конфигурации IMAP и
используйте action Переместить все с фильтром
для всей почты, полученной до определенной
даты, все сообщения электронной почты,
соответствующие критерию, теперь могут быть
перемещены из одной папки в другую без
каких-либо проблем.

15097 01753270 Теперь в пакет Google Диск вы можете
использовать action Создать разрешение на
файл с параметром Идентификатор файла.
Ранее при использовании действия Создать
разрешение на файл возникала ошибка, если
перед ним не было другого action Google Диск.
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15097 01276141 Если в пакет электронной почты вы используете
action Переместить все или итератор Цикл
> Для каждого сообщения в почтовом
ящике, теперь вы можете добавить любое
количество адресов электронной почты в поле От
определенного отправителя поле. Ранее цикл
электронной почты не работал, если в поле От
определенного отправителя было более двух
адресов электронной почты.

15097 01689348 You can no longer import боты with incomplete пакет
files from one Control Room to another because
the system now disallows and rejects the import of
incomplete пакет files.

15097 01763262, 01762153 You can now create a бот and run stored
procedures successfully. Previously, if you had
two stored procedures in different databases,
for example, Database A.dbo.SP_A and
Database_B.dbo.SP_B, in the Сервер SQL, if
you were connected to Database_A and wanted
to run the stored procedure in Database_B, the
execution failed because the fully qualified stored
procedure name was not supported in the Run stored
procedure action.

15097 -- You can now successfully download exported bots by
navigating to Activity > Historical > Bot Export:
Export.<date_name > Download exported zip
file.

15097 01762348 Боты, которые развертываются из Control Room
на пользовательских устройствах, больше не
застревают в очереди после того, как Bot Runner
без сопровождения добавляются из группы
устройств.

15097 01151181 Если у вас есть необходимые разрешения, вы
теперь можете успешно удалять неактивные
расписания со страницы Управление >
Запланировано > Запланированные
действия. Ранее, даже если у вас были
необходимые разрешения на планирование,
при попытке удалить неактивное расписание
появлялось сообщение об ошибке, связанной с
разрешениями.

15097 00917927, 01255618 В поле Кем изменено на странице Управление
> Запланировано теперь отображается
правильное имя пользователя для повторяющихся
расписаний. Ранее при импорте расписаний из
одного окружения в другое в поле Кем изменено
отображалось имя пользователя первоначального
Bot Creator или администратора.
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15097 01778350, 01803570 Когда вы создаете расписание в Control Room,
на странице Управление > Запланировано >
Просмотреть действие > Расписание теперь
отображается правильное время окончания
для поля Дата окончания. Ранее, когда для
расписания была выбрана дата окончания,
для поля Дата окончания отображалось
неправильное время окончания.

15097 -- При попытке создать очередь в окружении
Kubernetes больше не возникает ошибка.

15097 00716776,
00778659,
01820190, 01856732

If you check out an item at certain time T1 and then
cancel the checkout later at time T2, the canceled
checkout is not considered as a modification to
the item. Also, the last modified time is rolled back
to time T1 that is when the bot was checked-out
last time from the Public folder. Previously, the
canceled checkout at certain time T2 was incorrectly
considered as a modification to the item. Also, the
last modification time was incorrectly shown as time
T2 that is when checkout was canceled. Thus, it was
difficult to keep track of actual modification dates of
items.

15097 -- В окружении Kubernetes теперь можно удалять
рабочие операции даже после приостановки
очереди. Ранее, когда вы приостанавливали
очередь и пытались удалить рабочую операцию,
иногда возникала ошибка, которая не позволяла
удалить рабочую операцию.

15097 01255617 Фильтры WLM на странице Очередь > Рабочие
операции теперь выдают точные результаты.
Ранее фильтры работали неточно, когда их
объединяли.

15097 01806221,
01805371,
01818356, 01828330

After you update to Automation 360 v.24, WLM
tasks no longer fail. Previously, after an update,
бот execution processes or actual бот execution
sometimes failed, resulting in the failure of WLM tasks
as well.

15097 01769740 Описания Бот теперь отображаются даже после
загрузки или выгрузки бот. Ранее, после того как
вы в первый раз загружали или выгружали бот,
описания бот переставали отображаться.
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15097 01764336 Теперь отображается соответствующее сообщение
об ошибке при попытке изменить статус рабочей
операции с Готово к запуску на На удержании
или Завершено. Теперь сообщение об ошибке
информирует вас о том, что поскольку очередь
уже используется, вы должны либо приостановить,
либо остановить автоматизацию очереди, чтобы
изменить статус рабочей операции. Ранее
выводимое сообщение об ошибке не помогало
устранить проблему.

15097 01273374 API gettasklogdata теперь показывает данные
в режиме реального времени, при этом значения
местного времени преобразуются в значения UTC
для данного запроса API.

В приведенной ниже таблице перечислены ограничения, выявленные в текущем выпуске.

Ограничения

Боты whose queue category name contains a space (for example, Input – Emails) cannot be
migrated because during migration, such боты enter and remain in an infinite loop until the loop
times out at 90 minutes. (ID обращения к облачному сервису: 01850864)
Обходное решение. You can migrate to Automation 360 v.26 release where this issue is fixed or
remove the space in the queue category name and then migrate the боты.

After you migrate your боты, an error occurs in the following situations:
• When you use FTP actions on боты with commas in filenames
• When you use the Delete files and Delete folder FTP actions on боты with colons in

filenames

Обходное решение.
• For боты that use FTP actions, ensure that you remove commas from the filenames.
• For боты that use the Delete files and Delete folder FTP actions, ensure that you remove

colons from the filenames.

When you try to migrate боты in which the Если condition is used for more than 95 times in a
single line, migration fails with the following error message: Unexpected response status:
500 (Service Cloud case ID: 01830793)
Обходное решение. Divide the bot into multiple logical sub-bots.

(ID обращения к облачному сервису: 01773164) If the number of cells in a table object exceeds
300,000, the Control Room might become unresponsive.
Обходное решение. Ensure that the number of cells in a table object does not exceed 300,000.

Даже если путь к Control Room является недопустимым или не существует, недопустимый
путь все равно отображается вместо пути по умолчанию: C:\ProgramData
\AutomationAnywhere\GlobalCache\
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When you run a migrated бот with the Средство записи пакет, the Click Action on Client
Control might not work. This issue occurs because some Microsoft Windows operating systems
might not be activated properly on a few Windows applications.
Обходное решение. Use the Left Click action.

When you try to re-edit a migrated бот with the Record > Dataset variable, an error occurs,
and the following error message is displayed: An unexpected problem occurred. If the
problem persists, please contact your system administrator.

Обходное решение. Refresh the Bot editor page to reload the details.

A parse error occurs when you run a migrated бот with the Email Received Date variable used
twice in subactions inside the Эл. почта loop action.

Когда вы создаете бот с помощью action Отправить сообщение эл. почты, если
вложение содержит символ «меньше» (<) в качестве специального символа в пути к файлу,
специальный символ удаляется после выполнения бот. Операционная система Windows не
поддерживает этот специальный символ.

Когда в бот вы создаете переменную Список подтипа Файл, выбираете значение как файл
Control Room и добавляете пакет Список, не удается выполнить бот, когда вы запускаете бот.

If your бот has an error, you add the Try/Finally block around the corresponding actions, and
insert more actions in the Finally block, when you save and run the бот, the Bot error dialog
shows the wrong error line number within the Finally block.
Обходное решение. If you are using Try and Finally without using the Catch action, the Bot
error dialog does not show the correct line number. Instead, use Try/Catch. The Try action
handles the error and sends execution to Catch with line number and description. This gives the
correct line number within the Finally block.

When you frequently connect to the Excel or Access (Microsoft Office 2016 or later) engines with
ODBC drivers, бот execution fails intermittently.

When you use the Connect action to connect with the EWS protocol, read email skips the newline
characters and prints the email message body on a single line. This issue is also observed in the
Send email action. Following are the scenarios where these issues are observed:
• Create a бот and connect with the EWS server. Use the Loop action to read emails as a plain

text message and use the Log to file action to log text into a file.
• Use the Send email action and connect with the EWS server with OAuth authentication to

send the email.

Когда в группе устройств вы выбираете Запустить бот сейчас для бот WLM, запускается
бот WLM и отображается сообщение об ошибке.
Обходное решение. Чтобы запустить бот WLM в группе устройств, проверьте, что вы
выбрали параметр Запустить бот с очередью.

Когда в многоклиентском окружении вы загружаете файл рабочей операции в очередь
в одном из клиентов, на вкладке В процессе выполнения отображается тот же файл
рабочей операции для всех остальных клиентов.
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Ограничения

Когда в группе устройств вы останавливаете автоматизацию WLM, несколько рабочих
операций все еще находятся в состоянии готовности к выполнению. В результате эти рабочие
операции не могут быть удалены.
Обходное решение. Чтобы удалить рабочие операции в состоянии готовности к
выполнению, выполните одно из следующих действий.
• Приостановите и остановите автоматизацию.
• Перезапустите, приостановите, а затем остановите автоматизацию.

After migration, when you use the Excel advanced > Open action to open a file with the Load
Add-ins option enabled and the system has COM add-ins enabled, when you run the бот, the бот
might fail with an error.
Обходное решение. Disable the Load Add-ins option to run the боты successfully.

When you use the If > Folder does not exist condition to determine that a folder does not exist,
even if the folder exists, the бот might fail to identify it due to the leading and trailing spaces in the
input folder path. As a result, the бот might throw an error.

When you update the Control Room to the latest version, you might see some пакеты with two
default versions.
Recommendation: Sometimes, you might notice the duplicate пакеты a few weeks after the
Control Room is updated. Hence, we recommend that you compress and save the Control Room
logs dir that contains all the WebCR*.log files 30 minutes after the Control Room is updated. This
way, if you discover the issue later, these logs from the time of update will be available and help in
investigating this issue.

In the Data Table > Assign action, when you select the Table with values option, select the
Edit table (1 X 1) option to edit a table, enter variables in the rows and columns and then run the
бот, the output still shows the input $variable$ instead of the evaluated value of the variable.

When you try to upload пакеты to the Control Room manually, the system does not check for the
minimum required version of the Control Room that is compatible with the пакеты before they
are uploaded. It allows the пакеты to be uploaded in the Control Room even if the version of the
пакеты is not compatible with the currently installed version of the Control Room.

When you use the Run bot option to run a бот in the Activity > Historical > View page for any
activity, the бот execution fails with an error.

(ID обращения к облачному сервису: 01784401) To ensure that multiple Git processes are not
modifying the same repository at the same time in the Control Room, Git lock is implemented for
a short interval. After the lock is released, repository-related operations are resumed without any
issues. However, in some instances, the Git lock is not released, and new Git operations cannot be
processed. As a result, repository-related operations, such as edit, save, import, and check-in, are
delayed and eventually time out.
Обходное решение. Обратитесь в поддержку Automation Anywhere.

When you use the Если пакет, add a specific condition with a variable, then add specific conditions
within a group, save the бот, and if you rename the variable that was used, the name of the
variable might not update for the Group conditions but is only updated for the conditions in the
Condition tab.

© 2023 Automation Anywhere. All rights reserved.     248



    Automation Anywhere - Learn

Ограничения из предыдущих выпусков

Когда вы выполняете миграцию бот, который использовал action Manage Window Controls,
последняя цифра значения высоты недоступна после миграции. Тем не менее, бот будет
выполнен успешно. (ID обращения к облачному сервису: 01756996)

Когда сеанс Excel активен в SAP, соответствующий процесс Excel запускается в фоновом
режиме. В таком сценарии Automation 360 использует тот же процесс Excel, который запущен
в SAP. Когда вы запускаете бот для автоматизации данных электронной таблицы, Automation
360 успешно обрабатывает первый запрос. Но если Excel закрыт во время выполнения
и отправляется следующий запрос на автоматизацию данных электронной таблицы,
Automation 360 не обрабатывает запрос, поскольку к процессу Excel все еще обращается SAP.
Поэтому для автоматизации данных электронной таблицы не активируется нужное окно. (ID
обращения к облачному сервису: 00815159)

• If you are updating from Automation 360 On-Premises v.21, remove the following Bot Agent files
and folders:
• C:\Windows\System32\config\systemprofile\AppData\Local

\AutomationAnywhere\AA-DB.mv.db
• C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-resources

• Before you update from Automation 360 On-Premises v.22, refer to the upgrade considerations
in Обновление до последней версии Automation 360.

(ID обращения к облачному сервису: 00837271) Если вы выполняете миграцию с Enterprise
11 при использовании базы данных, содержащей большое количество данных репозитория,
установка может завершиться неудачей. Эта проблема возникает из-за того, что во время
миграции обновление Liquibase для нескольких SQL-запросов не выполнено.
Обходное решение. Contact Automation Anywhere Support.

When you try to automate any process in a Java application that uses version 11.0.8 of
AdoptOpenJDK, the Средство записи might not capture the drop-down elements on the
application.

Когда вы используете Средство записи для захвата объекта, выбираете свойства Тег HTML,
Внутренний текст HTML и Тип HTML в разделе Критерии поиска или выполняете
миграцию бот с похожими свойствами, выбранными в разделе Критерии поиска, бот не
может идентифицировать или найти объект и выполнить выбранное действие.
Обходное решение. Modify the DomXpath according to the controls you capture, or add more
properties in Search Criteria.

When you use the Browser > Close action to close a tab or a window opened in the Microsoft
Edge browser, if only one Microsoft Edge browser window is open, the бот encounters the following
error: Error occurred while closing the tab
Обходное решение. См. Configure Microsoft Edge browser settings when Close action of Browser
package encounters an error (A-people login required)

Обновления после прекращения поддержки Internet Explorer

Прим.:  This release (Automation 360 v.25) includes features from Automation 360 v.24R2 (Сборка
13331). Информацию о том, что доступно в выпуске v.24R2, см. в Заметки о выпуске Automation
360 v.24R2 для прекращения поддержки Internet Explorer 11.
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Функции

Пакеты и actions
You can now migrate Internet Explorer боты from Enterprise 11 and Enterprise 10 to Automation
360 and convert the боты to Microsoft Edge with IE mode for the following actions and
commands in the Средство веб-записи пакет:
• actions Перейти по URL-адресу, Назад и Поиск по подписи.
• Команды Открыть браузер и Закрыть браузер. Эти команды привязаны к actions

Автоматизация предыдущих версий > Открыть страницу и Закрыть страницу в
Microsoft Edge с режимом IE.

Для запуска боты Internet Explorer в пакет Автоматизация предыдущих версий выберите
параметр Запустить Internet Explorer в режиме совместимости Edge.
To migrate and convert Internet Explorer боты, in the Control Room, from Administration >
Migration > Migrate bots, select the Convert bots built using Internet Explorer to Edge
with Internet Explorer mode option.

Automation Anywhere Robotic Interface (AARI)

Прим.:  For Automation 360 v.25, AARI does not support an Oracle Database. You can continue to use
AARI with Microsoft SQL Server.

Новые возможности

Use Bot Task labels to identify bot version to run
На странице Задача бота теперь можно выбрать версию бот для развертывания, выбрав
между Последняя версия и Метка производства. Когда вы развертываете бот,
запускается версия бот, которую вы выбрали.

Создание процесса AARI

Бот priority reference
Теперь вы можете указать уровень приоритета ваших боты в разделе Задача бота. Для боты
с заданным уровнем приоритета в разделе Приоритет бота теперь отображаются метки
только для чтения (Низкий, Средний или Высокий).

Создание процесса AARI

Создание запроса в новой вкладке
Теперь вы можете открывать и запускать новые запросы в отдельной вкладке, выбрав
параметр Открыть запрос в новой вкладке в исходной форме. С помощью этого
параметра вы можете одновременно создавать запросы, не уходя с открытой в данный
момент страницы.

Создание запроса и завершение задачи
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Новые возможности

Недействительный планировщик
Планировщик является недействительным, если у пользователя планировщика отсутствует
требуемая функция или если он не может получить доступ к файлу из-за отсутствия
разрешений. Пользователи, которые получают уведомление о недействительном
планировщике: администраторы Control Room, администраторы AARI и пользователи AARI.
Теперь администратор Control Room видит изменение в журнале аудита, администратор
AARI видит сообщение об ошибке и должен переназначить пользователя планировщика, а
пользователь AARI видит сообщение об ошибке в своем процессе.

Назначение пользователя планировщика процессу в веб-интерфейсе

Дублирование строк для элемента «Таблица»
В веб-интерфейсе, когда вы добавляете строки в форму с помощью элемента Таблица,
теперь можно сэкономить время, продублировав строку в таблице с помощью нового
параметра Дублировать строку. Дублированная строка теперь размещается под
выделенной строкой, которую вы выбрали.

Триггеры интерфейса поддерживают больше технологий
Теперь вы можете использовать триггеры интерфейса со следующими технологиями:
• собственная технология Windows,
• рабочий стол SAP,
• браузеры Google Chrome и Edge Chromium.

Add an interface trigger
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Новые возможности

Усовершенствования правил формы
• Использование пользовательского форматирования

При добавлении правила, если вы используете меню Если для задания условий правила
для определенных элементов, таких как Текстовое поле или Область текста, вы
теперь можете выбрать вариант Является из раскрывающегося меню для активации
дополнительных параметров. Select the Custom option and click Add regular expression
to apply custom formatting requirements on the selected element.
Рассмотрим сценарий, в котором идентификаторы пользователей всех ваших сотрудников
имеют префикс AV. Так, например, сотрудник, которого зовут Адам, имеет идентификатор
пользователя AVAdam. Используйте параметр Добавить регулярное выражение, чтобы
установить в поле Регулярное выражение значение «^AV». Если пользователь вводит
Adam в поле идентификатора пользователя, отображается предупреждение.

• Установка пользовательского значения или добавление значения элемента
Когда вы добавляете правило, используйте меню Тогда для выбора элемента формы.
Для этого элемента формы можно задать одно из соответствующих действий с помощью
функции Установить значение или Добавить значение:
• Значение: данные, введенные в поле Введите значение, применяются к выбранному

элементу.
• Элемент формы: добавляются данные из элемента формы, выбранного в

раскрывающемся меню Выбрать элемент.

Рассмотрим сценарий, в котором форма регистрации пользователя содержит поля «Имя»
и «Идентификатор сотрудника». Вы можете установить одно из следующих правил для
значения в поле «Идентификатор сотрудника»:
• Выберите Значение и введите Emp1013 в качестве предустановленного значения.

Это значение отображается в поле «Идентификатор сотрудника» при запуске бот.
• Выберите Элемент формы и элемент «Имя» в раскрывающемся меню Выбрать

элемент.
Значение из поля «Имя» добавляется к полю «Идентификатор сотрудника» при запуске
бот.

Вы можете использовать элементы так же, как используются переменные в Bot editor. Вы
можете ввести $ для просмотра списка элементов.

Добавление правил к элементам формы

Изменения

Ссылка на запрос для пакет AARI Web
пакет AARI Web теперь поддерживает идентификаторы ссылок. Идентификатор ссылки — это
сочетание префикса и номера, который создается на основе ключа процесса и увеличивается
каждый раз при создании запроса. ID запроса меняется на Ссылка на запрос, а ID
группы меняется на Ссылка на группу.
AARI Web пакет
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Изменения

Process and пакет version changes in Get Storage file action
Теперь для выполнения action Получить файл хранилища требуется, чтобы версии
процесса и пакет совпадали. Процессы, созданные до Automation 360 v.25, должны
использоваться с версиями пакет до Automation 360 v.25. Аналогичным образом, процессы,
которые созданы после Automation 360 v.25, должны использоваться с версиями пакет после
Automation 360 v.25.
AARI Web пакет

Исправления

Сборка ID обращения к
облачному сервису

Описание

15112 01841448, 1839118,
1844817, 01846153,
01846332, 01839254

When you download a series of пакеты from the бот
compilation, the download is now faster.

15112 01847675 After you update to Automation 360 v.25, when you
modify a process in a private workspace, you can now
save your changes successfully, without encountering
an error. Previously you will get a process error when
you attempt to modify and save your process, or when
you open the same process again.

15112 01848192 After you update to Automation 360 v.25, you can now
insert or modify conditions, such as the If/Else logic,
to your process without any issues. Previously when
you made changes or add the If/Else element to the
process logic, a Go to element would be added to the
logic which caused a process error.

15097 01807181,
01809192, 01816444

Пользователи облака. You can now successfully
upload a file for your requests. This applies to some
scenarios when you upload a file and the request
creation fails.

15097 01771877 In the process editor, at the end of your process, you
can now drag Go To and add it to your End Point.

15097 01774331 When you use the Row before scrolling option from
the Table element and specify a number of rows, the
web interface now renders the correct number of rows
that you specified.

15097 -- When you use the Document element and click the
Fit option to fit your document in request view, the
document is now scaled to fit the frame entirely.

15097 -- If you design a form with a drop-drown rule applied to
it, when you view the drop-down in read-only mode
in the web interface, you can now view the changed
data.

© 2023 Automation Anywhere. All rights reserved.     253



    Automation Anywhere - Learn

Исправления

Сборка ID обращения к
облачному сервису

Описание

15097 -- After you are disconnected, when you log back in to
the web interface, the next= parameter is no longer
shown in the URL and you are now redirected to the
page that you were on before you were disconnected.

15097 -- For the Text Box element, the Does not contain
form rule now works correctly.

15097 -- For the Rich Text Editor element, the Contains
form rule is now working correctly.

15097 -- Когда вы создаете форму с элементами Документ
и Выпадающее меню, вы теперь можете
отправлять форму без проблем.

15097 -- You can now use Request Reference as a parameter
in the AARI web пакет.

15097 01803846 You can now use Request Reference in the AARI
web пакет, for example, as an output for the Create
a Request action. Request ID is now replaced by
Request Reference.

15097 -- You can now successfully submit an initial form that
has a table with no content, data, or rows.

15097 01803019 When you open and view a task, the task assignment
now correctly shows the user assigned to that task.

Ограничения

When you attempt to delete a request that is associated with more than one file, the deletion fails.

After you create a request from a private process, when you attempt to open and run the request
in a new tab, a new tab is generated but it fails to run the request and the URL is not correct.

© 2023 Automation Anywhere. All rights reserved.     254



    Automation Anywhere - Learn

Discovery Bot

Fix

ID обращения к
облачному сервису

Описание

00971940, 01018262,
01255326, 01829662

You can now successfully record a process without encountering an
error because when you log in to the Control Room, the proxy settings
now support the following scenarios:
• No proxy is enabled.
• Proxy is entered with username and password.
• Proxy is entered without username and password.

Previously, when you recorded a process, if there was no proxy and if
you entered a username and password with proxy enabled, an error
occurred.

Document Automation

New capability: Document Automation — это новое Cloud решение для интеллектуальной обработки
документов, которое бизнес-пользователи могут настроить для автоматического чтения и быстрой
обработки документов с использованием предварительно обученных моделей и обратной связи при
валидации.
Решение Document Automation полностью интегрируется в Automation 360: Document
Automation устанавливается как часть Control Room, боты RPA используются для извлечения
полуструктурированных данных с целью автоматизации бизнес-процессов, ориентированных на
работу с документами, и Automation Anywhere Robotic Interface управляет сквозным процессом
извлечения и задачами валидации.
Document Automation

Ограничения

Although the v.26 Document Extraction пакет appears in the .v25 On-Premises Control Room,
features will not work as expected.
Workaround if the пакет version is auto-synced: Manually change the Document Extraction
пакет version to v.25. См. раздел Обновление боты до версии пакет по умолчанию.

Document Automation не поддерживает развертывание SDS.

Google Document AI pretrained models are available only for Cloud customers who purchased
licenses through Automation Anywhere.

Customers who install Document Automation on Linux must separately download the Document
Extraction пакет.

Document Automation поддерживает имя пользователя устройства длиной 21 символ или
менее.

The value beside the Validate documents link, which indicates the number of documents
awaiting validation for a learning instance, sometimes does not appear.

Learning instances that use Google Document AI models do not reliably extract tables that span
multiple pages.
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Ограничения

When you are validating a document in public mode, if you zoom in or out, you cannot drag the
corners of the system-identified region (SIR) selection.

When you are validating a document, if you draw a box, zoom in, and then click Fit to screen, the
box appears at a different location from where you clicked.

Если вы подключаетесь к обучаемому экземпляру из Automation 360 IQ Bot с дополнительным
полем, для которого установлено значение по умолчанию, и несколькими полями без
сопоставления, то при обработке документов в этом обучаемом экземпляре в Document
Automation значение по умолчанию появляется в несопоставленных полях.

Отсутствует уведомление, если срок действия лицензии продукта истекает. По истечении
срока действия лицензии вкладка Обучаемые экземпляры удаляется из Control Room.

You might encounter extraction issues when you process documents with tables that span multiple
pages.
Обходное решение. Обратитесь к менеджеру по работе с клиентами, чтобы загрузить
исправление для пакет Document Extraction.

When a бот runs an action from the Document Extraction пакет, the Activity > In progress page
shows the item name as IQBotAutoExtract.

The Bot Agent does not verify whether the Document Extraction пакет version is compatible with
the Control Room version prior to running a бот.

Document Automation cannot process documents in Automation Anywhere pretrained models if the
Bot Agent runs through a proxy.
Обходное решение.
• With authentication: Create a Windows environment variable HTTP_PROXY with a value of

http://<username>:<password>@<proxyhost>:<proxyport>.
• Without authentication: Create a Windows environment variable HTTP_PROXY with a value

of http://<proxyhost>:<proxyport>.

If a document is renamed to a new file extension and uploaded to a Google Document AI
pretrained model, the document will fail processing.
Обходное решение. Rename the document to the correct file extension.

Боты containing actions from the Document Extraction пакет must be deployed as part of an AARI
process. Standalone боты are not supported.

В некоторых случаях Bot Agent не очищает свою папку ресурсов. Пока дисковое пространство
не будет освобождено, это будет влиять на производственные документы, находящиеся в
обработке. Эта проблема возникает периодически.
Обходное решение. Исходя из проблемы, необходимо создать планировщик задач для
очистки папки ресурсов каждый день или каждую неделю.

IQ Bot

Прим.:  For Automation 360 v.25, IQ Bot does not support an Oracle Database. You can continue to use
IQ Bot with Microsoft SQL Server.
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Новые возможности

Миграция функций, связанных с обучаемым экземпляром
Теперь вы можете получить список пользовательских функций с доступом к обучаемому
экземпляру в исходном окружении и предоставить пользователям в целевом окружении
доступ к обучаемому экземпляру с помощью API Миграция функций.
IQ Bot roles migration APIs (A-People login required)

Отслеживание количества страниц, обработанных в стандартных формах,
отдельно от IQ Bot
На странице «Лицензии» в Control Room теперь отображается количество страниц,
обработанных в стандартных формах, классификаторе и с помощью IQ Bot. Если лицензии
добавлены в Control Room из Cloud, на странице «Лицензии» также отображается количество
страниц, обработанных в других экземплярах Control Room.

Лицензии Automation 360

Изменения

Reinstall IQ Bot services using a new script
Теперь вы можете переустановить все службы IQ Bot вместе или переустановить их по
отдельности с помощью сценария reinstall-allservices.bat.

Контрольный список после установки

Исправления

ID обращения к
облачному сервису

Описание

00780662 Ошибка округления больше не приводит к тому, что документы
не проходят проверку формул. Ранее эти документы проверялись
вручную.

01763658 For the Concatenate Images action in the IQ Bot Pre-processor
пакет, if a filename does not exceed 256 characters, the output is now
successfully generated.

01795651 При экспорте файла IQBA из обучаемого экземпляра типа
пользовательского домена с ручными группами в другой
обучаемый экземпляр ручная Метка группы теперь успешно
экспортируется. Ранее без ручной Метки группы в новых
обучаемых экземплярах было трудно отличить группы, созданные
системой, от групп, созданных вручную.

00780712 При импорте файлов IQBA с использованием данных VisionBot
среди обучаемых экземпляров теперь можно увидеть созданные
новые группы. Ранее новые группы не создавались при загрузке
документов.

-- Сообщение об ошибке больше не отображается при изменении
языка отображения любого обучаемого экземпляра, в котором
есть документ в Валидатор. Ранее система выдавала ошибку,
даже если выбранный язык отображения успешно применялся к
обучаемому экземпляру.
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Исправления

ID обращения к
облачному сервису

Описание

-- Когда вы используете параметр Заменить для импорта
обучаемого экземпляра, Группа проверок по умолчанию
теперь успешно перезаписывается. Ранее Группа проверок
по умолчанию не перезаписывалась и приходилось вручную
редактировать обучаемый экземпляр после импорта файла IQBA и
менять группу по умолчанию.

-- Когда вы используете пакет IQ Bot Extraction, вы можете
просмотреть количество документов на странице Сведения
обучаемого экземпляра. Ранее, если вы обрабатывали документы,
которые не принадлежали ни к одной из созданных групп, они не
отображались на странице Сведения обучаемого экземпляра.

-- Теперь вы можете сортировать элементы в столбце Загрузка
страниц на вкладке Обучаемый экземпляр > Группа
документов. Ранее отображалось следующее сообщение об
ошибке: System error, please try again after some
time

-- Когда в приложении Designer вы изменяете размер определяемой
системой области для поля с автоматическим сопоставлением,
значения из области, размер которой изменен, теперь точно
отображаются в соответствующем поле значений.

-- Database Migration Assistant Tool now notifies with an error if there
are any environmental issues (such as missing DLL). Previously, the
tools and logs indicated that migration was complete, even if a unified
database was not created.

-- Когда имя файла с нелатинскими символами загружается
с помощью домена счетов-фактур и обрабатывается с
помощью команды AutoExtract, теперь генерируются регионы,
идентифицированные системой. Previously, to process the
documents successfully, you had to convert the non-English filename
to English characters.

-- Если вы импортируете обучаемый экземпляр с установленной
группой проверки по умолчанию в среду, в которой обучаемый
экземпляр был ранее удален, настройка группы проверки по
умолчанию остается неизменной. Ранее импортированный
обучаемый экземпляр отображался без группы проверки по
умолчанию.

-- Имя заголовка столбца для Группа проверок по умолчанию
теперь отображается в файле Projectdetails.csv, полученном
при экспорте обучаемого экземпляра.

-- При работе с обучаемым экземпляром стандартных форм, если вы
попытаетесь обработать большое количество документов (более
10 000) с помощью action Обработка документов из пакет IQ
Bot Extraction, некоторые документы могут быть не обработаны.

-- Во время обновления пакет IQ Bot Extraction не возникает
задержка обработки документов и результатов пропускной
способности, даже если вы используете Tesseract4 OCR.
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Исправления

ID обращения к
облачному сервису

Описание

-- В обучаемых экземплярах стандартных форм теперь можно
установить значение по умолчанию для необязательных полей.
Если для необязательного поля не удается извлечь данные,
система использует значение по умолчанию, которое вы
установили.

-- Теперь вы можете получить доступ к обучаемым экземплярам
стандартных форм, созданным в более ранних версиях IQ Bot,
которые были установлены с помощью ключа хранилища CyberArk.

Ограничения

IQ Bot Cloud: If you do not access IQ Bot within the configured Ideal time out value set on the
IQ Bot server, the following things happen:
• Отображается сообщение о необходимости перезапустить IQ Bot.
• При перезагрузке сервера происходит сбой Боты, которые используют API IQ Bot.

Обновите веб-страницу IQ Bot через некоторое время (более 5 минут), чтобы войти в IQ Bot.

На экране Валидатор, если для обновления поля, к которому были применены проверки,
используются неверные значения, предупреждение не отображается, если это поле
неактивно.

Если вы используете action Обработка документов из пакет IQ Bot Extraction для
извлечения содержимого из большого количества документов (более 1 миллиона),
отображается сообщение об ошибке и IQ Bot может перестать отвечать.

Когда вы получаете доступ к приложению IQ Bot через Internet Explorer 11, следующие
функции не работают должным образом.
• Export option on the dashboard
• Значки в списке меню
• Список действий на странице Боты
• Значок Действие для обучаемого экземпляра
• Функциональные возможности валидатора, такие как:

• Добавить строки
• Удалить строки
• Функция поиска
• Значок скрытия
• Тип данных для полей формы

В Community Edition IQ Bot, когда вы используете Распознавание текста (OCR) Cloud для
создания обучаемого экземпляра, если вы используете action Обработка документов IQ
Bot из пакет IQ Bot Extraction, значения из загруженных счетов-фактур или документов не
обрабатываются корректно.
Обходное решение. Если вы используете Распознавание текста (OCR) Cloud для создания
обучаемого экземпляра, используйте action IQ Bot Загрузить документ из пакет IQ Bot.
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Ограничения

When you click the Create Backup option on the Migration Management page and select the
learning instances to be backed up by using the Search drop-down list, the learning instances
selected become deselected. В результате вы не можете создать резервную копию обучаемых
экземпляров.
Обходное решение. Вместо использования раскрывающегося списка Поиск выберите
обучаемые экземпляры из списка на странице Резервное копирование обучаемого
экземпляра.

В обучаемом экземпляре внутреннего валидатора не отображается ошибка, когда вы
пытаетесь ввести или изменить данные в дочерней таблице, которые не существуют в
родительской таблице. Это приводит к тому, что документы сохраняются с неправильными
значениями.

Когда вы используете пакет IQ Bot Extraction вместе с другими командами на основе OCR
(такими как IQ Bot Pre-processor, IQ Bot Classifier, AISense Recorder и Распознавание текста
(OCR)) в одном бот, выполнение бот завершается сбоем.
Обходное решение. Убедитесь, что вы создали отдельные боты для IQ Bot Extraction, и не
запускайте IQ Bot Extraction в сочетании с другими пакеты, которые включают 12.2 Abbyy
OCR.

При установке IQ Bot с аутентификацией Windows и хранилищем CyberArk невозможно
выполнить ротацию ключа, и отображается следующее сообщение об ошибке: Произошла
ошибка при установке нового ключа.Проверьте журналы

В некоторых случаях Bot Agent не очищает свою папку ресурсов. Пока дисковое пространство
не будет освобождено, это будет влиять на производственные документы, находящиеся в
обработке. Эта проблема возникает периодически.
Обходное решение. Исходя из проблемы, необходимо создать планировщик задач для
очистки папки ресурсов каждый день или каждую неделю.

If you have a document with more than 100 pages, an error message is displayed intermittently
when you click See extraction results for an existing learning instance.

Если вы используете ABBYY FineReader Engine версии 12.4 вместо версии 12.2, функция MICR
не поддерживает извлечение данных из документов на японском языке.

When you download an unclassified document, click Delete from the server, and then toggle
the learning instance from production to staging, and vice versa, as a consequence, the same
document starts reappearing in the untrained output folder, and when you download the document
from untrained groups, the same document reappears even though it has been deleted.

When you upload documents to production using IQ Bot Upload > Run the command,
toggle the learning instance from production to staging, and then toggle back to production, all
unprocessed documents appear blurred.
Обходное решение. Upload documents to Staging using an API. Upload document to Staging API
(A-People login required)
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Ограничения

As a result of upgrading Control Room and IQ Bot from A360.21 to A360.25, you are unable to edit
groups in the learning instances, and move groups from Staging to Production.
Workaround:
1. Restore the latest IQ Bot database backup.
2. Run the delete query.
3. Delete from EncryptionKey.
4. Run the following query: NSERT INTO EncryptionKey ([Key],

[Type]) VALUES ('xDxQoAhIc/R0nF+bFXHuo6/UGnnm6Hqs/
uBVxYpz1IdU6UAEUUVYf5vnFJU6qkBcnCAvdQOUjdwrJWwWW4LdKA==','data')

5. Start the A360.25 installer.Post upgrade checklist:
6. Ensure that following logs details are not available in installion-helper.log file: [ INFO]: main/

com.automationanywhere.cognitive.installationhelper.infrastructure.datarotation.DataRotationServiceImpl
- Rotation starts.

7. Run the API, and ensure that the filename has proper value (it should not be "fileName" :
"THIS STRING IS NOT ENCRYPTED",). http://localhost:9996/organizations/1/projects/
%7BLearningInstanceID%7D/categories/%7BgroupNumber%7D/files

Прим.:  Replace the value of {LearningInstanceID} and {groupNumber} properly. Also,
GroupNumber should belong to same learning instance.

Отсутствует уведомление, если срок действия лицензии продукта истекает. По истечении
срока действия лицензии вкладка Обучаемые экземпляры удаляется из Control Room.

Bot Insight

Изменения

Информационные панели теперь требуют использования пакет анализа версии
2.3.0-20210922-121532 или более поздней версии. This version of the пакет is available from
Automation 360 v.23.

Информационные панели Bot Insight

Исправления

ID обращения к
облачному сервису

Описание

01755186 Когда вы используете фильтр в отдельном виджете, фильтр
теперь корректно применяется только к нему, как и ожидается.
Ранее фильтр, предназначенный для определенного виджета,
иногда применялся и к другим виджетам.
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Automation Anywhere for Genesys

Новые возможности

Automate tasks for Genesys platform with Genesys пакет for Automation 360
Use the actions in this пакет for onboarding and updating records in the repository. На каждой
палитре action можно создавать одну или несколько записей, а также удалять actions для
записей. You can list or search records for referencing the IDs required for updating other records.
You can also organize the records for communication purposes and contextual insight. The action
palettes in this пакет include the following:
• Создание записей: пользователь, подразделение, телефон, внешние контакты
• Систематизация записей: группа, очередь, внешняя организация
• Атрибуты записей: язык, функция, навык

Genesys пакет

Feature deprecations

Review features and capabilities (from Automation Anywhere or other third-party vendors) that are
deprecated or nearing deprecation to understand how they impact your automation. For more information,
see also this page: Feature deprecations affecting Automation Anywhere products.

Human-Bot Collaboration 11.3.x deprecated
The Human-Bot Collaboration (HBC) 11.3.x was deprecated from August 2020 with the release
of Enterprise A2019.15, after which the product has not been actively developed or maintained.
Customers that are using HBC 11.3.x are required to migrate to the Automation 360 platform to
use Automation Anywhere Robotic Interface (AARI), Web or Desktop. For this migration, there is
no automated migration path because of an absence of parity between the two products (including
sets of features). Any path that you take to migrate from HBC 11.3.x to the Automation 360
platform will involve significant manual steps to convert and map bots and other assets (such as
forms, teams, and tasks) to AARI assets (such as bots, forms, processes, teams).
Feature deprecations affecting Automation Anywhere products

Basic authentication in Exchange online
Microsoft has announced that starting October 1, 2022 Basic authentication will be permanently
disabled in Exchange Online. This change will impact боты used for email automation that connect
to Exchange Online with Basic authentication using IMAP, POP3, or EWS protocols. Hence, Microsoft
recommends customers to switch from Basic authentication to OAuth 2.0.
To maintain business continuity of the impacted боты, Automation 360 customers and partners
can leverage the OAuth 2.0 feature support in Эл. почта пакет and Эл. почта trigger that will be
delivered in the week of Aug 29th, 2022.
Deprecation of Basic authentication in Exchange Online | Everything about Basic Authentication
deprecation in Microsoft Exchange online (A-People login required)
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Manifest V2 extensions for Google Chrome and Microsoft Edge
As Google will deprecate Manifest V2 extensions by June 2023, this might impact your existing
automations that use our current MV2 extensions in Google Chrome and Microsoft Edge browsers.
You can choose to use the enterprise group policy to continue to use Manifest V2 extensions until
June 2023(Manifest V3 transition timeline). However, post this date, you have to switch to Manifest
V3 extensions for your automations to work.
We plan to provide Manifest V3 extensions for Google Chrome and Microsoft Edge with our next
release Automation 360 v.26. We recommend that you now start planning to switch to Manifest V3
extensions.
Chrome and Edge Manifest V3 extensions

Tesseract v3 OCR planned change from October 2022
Tesseract is an open source OCR engine leveraged by Automation 360 IQ Bot as part of document
processing and extraction. Tesseract v3 has not been updated since 2018, and it will no longer be
packaged with Automation 360 IQ Bot from the next release v.26 (planned for October 2022).
Tesseract 3 OCR was removed as an option from the IQ Bot learning instance creation user
interface about 2 years back (in our v.13 release). However, we continued to package this older
OCR version, which ensured that learning instances previously created on Tesseract 3 can function.
Starting from our next release Automation 360 v.26, Automation 360 IQ Bot will no longer package
Tesseract 3. From v.26 release, document processing against learning instances with Tesseract
3 will result in an error, indicating that this OCR version is not available. However, the learning
instances will remain in the system, allowing customers to view their details and train with
alternative OCR options (including Tesseract v4 OCR).
For all existing learning instances trained using Tesseract v3 OCR, we recommend that you plan
to train them with alternative OCRs (including Tesseract v4), before you update to v.26. Note that
Automation 360 IQ Bot Cloud customers will receive v.26 release by default from October.

IQ Bot Extraction package deprecation from October 2022
As part of Automation 360 v.25, IQ Bot Extraction package will no longer support pre-trained
machine learning model for invoice data extraction, but will continue to support learning instance
group based-training extraction.
We have released a new set of capabilities on pre-trained models with Document Automation as
part of v.25 release, including a new command package called Document Extraction. IQ Bot
Extraction package will be deprecated starting from the next release Automation 360 v.26, so we
recommend our customers to start leveraging this new Document Extraction package.
For more information about Document Extraction package and instructions on how to move
learning instances to Document Automation, see Move from IQ Bot Extraction пакет to Document
Automation.

Заметки о выпуске Automation 360 v.24R2 для прекращения
поддержки Internet Explorer 11
Дата выпуска: 17 May 2022

This release notes applies to the Automation 360 v.24R2 patch release for Cloud, On-Premises,
Sandbox, and Community Edition users impacted by the Internet Explorer end-of-life (IE EOL) and
who have therefore chosen to convert IE боты.
Cloud, On-Premises, IQ Bot, Sandbox, and Community Edition are on Build 13343.
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Прим.:  The IQ Bot build does not include any specific updates and is available to match the Control
Room build.

Почему именно этот выпуск

Корпорация Microsoft объявила о прекращении поддержки (End-Of-Life; EOL) Internet Explorer с
июня 2022 года и рекомендует использовать Microsoft Edge или Microsoft Edge в режиме IE. Этот
выпуск содержит пакеты, сертифицированные для Edge в режиме IE, и Update Bot wizard IE, которые
помогут вам обновить боты в массовом порядке для работы с Edge в режиме IE. Предстоящее
прекращение поддержки IE может повлиять на ваше развертывание в зависимости от используемой
в данный момент операционной системы, в которой запускаются боты.
Подробные сведения см. в приведенной ниже таблице.

Операционная система Microsoft Automation 360 боты

Лицензия Windows 10 Semi-Annual Channel Обновите боты, чтобы использовать
совместимый браузер.
Список поддерживаемых браузеров см. в
разделе Требования к браузеру для доступа к
Рабочая область RPA.

Все другие поддерживаемые операционные
системы

Нет непосредственного влияния

Начиная с Automation 360 v.25, выпуск которого предстоит, вам будет предложено получать
доступ к Control Room с помощью альтернативного поддерживаемого браузера, такого как Google
Chrome или Microsoft Edge (Chromium), вместо Internet Explorer. Доступ в Control Room с помощью
Internet Explorer будет невозможен. Ориентируясь на стратегию корпорации Microsoft по поддержке
браузеров, мы можем предоставить вам расширенные функции, которые поддерживаются
новейшими браузерами, такими как Google Chrome и Microsoft Edge.

Обновление до этого выпуска

You can update to Automation 360 v.24R2 On-Premises from the following previous releases that are
certified for update:
• v.24 (сборка 12350)
• v.23 (сборка 11513)
• v.22 (сборка 10526)
• v.21 (Build 9664, 9642, 9595)

As Community Edition and Sandbox are Cloud deployments, no manual upgrade is required. These
environments are automatically updated to Automation 360 v.24R2 Build 13343.
If you are not on any of the above certified releases, update Automation 360 to one of the certified
releases (listed previously) before updating to this release.
Информацию об обновлении до этого выпуска см. на указанных ниже ресурсах.
• Обновление до последней версии Automation 360
• Автоматическое обновление Bot Agent | Обновление Bot Agent вручную
• Compatibility with release builds
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Для получения информации о последних обновлениях до расширений Automation 360 для Google
Chrome, Microsoft Edge и Mozilla Firefox см. раздел Browser extensions for Automation 360.

Обновления Bot Agent

Этот выпуск включает в себя необязательное обновление Bot Agent. Чтобы использовать функции
в Automation 360 v.24R2, обновите Bot Agent, доступные в указанных ниже сборках.
• Bot Agent версии 21.200 для сборки 13343
• Bot Agent version 21.1000.14009 for Сборка 13331 (On-Premises pre-GA)

Обратите внимание, что если вы хотите запустить существующие боты, обновление Bot Agent до
этого выпуска не требуется.
If you have installed the Automation 360 v.24R2 pre-GA patch (Сборка 13331) with Bot Agent version
21.1000.14009, perform the following steps.
1. Удалите Bot Agent версии 21.1000.14009, предшествующей общедоступной версии.
2. Установите Bot Agent версии 21.200 для Automation 360 v.24R2 (сборка 13343).

Важное замечание:  Если вы переместили свои боты из среды приемочного пользовательского
тестирования (UAT) и развернули их в рабочей среде (PROD) с Bot Agent версии 21.1000.14009, вам
необходимо обновить пакеты до Bot Agent последней версии 21.200.

Функции Community Edition

Пакеты

Поддержка браузера Microsoft Edge для пакет Браузер и переменных окна
• Теперь в браузере Microsoft Edge в пакет Браузер на базе Chromium поддерживаются

указанные ниже actions.
• Закрыть
• Получить исходный код
• Назад
• Открыть
• Выполнить JavaScript

• Теперь в параметре Браузер можно из списка активных вкладок выбрать вкладки
Microsoft Edge.

Поддержка последней использованной вкладки браузера в action Браузер >
Открыть для Microsoft Edge и Google Chrome
Теперь можно открыть веб-страницу на новой или существующей вкладке с помощью
предустановки Последняя использованная вкладка браузера в указанных ниже
браузерах.
• Microsoft Edge
• Microsoft Edge в режиме IE
• Google Chrome
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Пакеты

Автоматизация веб-приложений Java
Теперь можно автоматизировать веб-приложения Java, которые работают на Microsoft Edge
Chromium в режиме IE, с помощью параметра Средство записи > Запись или Начать
запись.

Время ожидания по умолчанию для загрузки страницы в браузере Microsoft Edge в
режиме IE
Когда вы автоматизируете какие-либо веб-приложения в браузере Microsoft Edge в режиме
IE, теперь Средство записи по умолчанию ожидает 30 секунд, чтобы дать веб-странице
полностью загрузиться перед записью каких-либо объектов на странице, тем самым делая
обнаружение объектов более надежным.

Cloud, On-Premises, and Sandbox features

Control Room и Пакеты

Новый Update Bot wizard для Internet Explorer
• Используйте новый Update Bot wizard в Control Room для преобразования существующих

боты Internet Explorer в Microsoft Edge в режиме IE, чтобы обеспечить продолжение
выполнения этих преобразованных боты после прекращения поддержки IE.
Update Bot wizard for converting IE боты

• Обладая правами администратора, вы можете разрешить пользователю использовать
Update Bot wizard, назначив новые разрешения функции обновления Бот для доступа и
преобразования бот из Internet Explorer в Microsoft Edge в режиме IE.

Разрешения на использование для функции
• Используйте действие Просмотреть обновления бота в экземпляре преобразования

бот для просмотра сводных данных и статуса каждого преобразования бот. Вы можете
просмотреть информацию о действиях по отдельным номерам строк и при необходимости
предпринять действия для тех боты которые находятся в статусе "неудачно" или в статусе
"завершено с необходимостью выполнения действия или проверки".

Просмотр сведений о преобразовании для ботов IE

Автоматизация веб-приложений Java
Теперь можно автоматизировать веб-приложения Java, которые работают на Microsoft Edge
Chromium в режиме IE, с помощью параметра Средство записи > Запись или Начать
запись.
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Control Room и Пакеты

Преобразование боты Automation 360 со специфическими для браузера пакеты с
использованием перехода с Internet Explorer на Microsoft Edge в режиме IE
Вы можете преобразовать боты, которые используют Internet Explorer в Microsoft Edge
Chromium в режиме IE, для указанных ниже пакеты.
• Средство записи
• Браузер
• Приложение
• Имитация нажатия клавиш
• Экран
• Мышь
• Окно
• Распознавание текста (OCR)
• Интеграция приложений
• Распознавание изображений
• Если
• Цикл
• Ожидать

Чтобы преобразовать эти боты, используйте Update Bot wizard на вкладке
Администрирование > Обновление бота в Control Room.
Update Bot wizard for converting IE боты
Указанные ниже свойства браузерных пакеты и actions, предназначенных для работы в
Internet Explorer, обновляются для работы в Microsoft Edge в режиме IE.
• Боты, созданные с использованием окна на базе браузера или приложения, заголовка окна

и пути к приложению
• Значение переменной окна по умолчанию, заголовок окна и путь к приложению окна
• Переменные браузера и заголовок браузера

Поддержка браузера Microsoft Edge для пакет Браузер и переменных окна
• Теперь в браузере Microsoft Edge в пакет Браузер на базе Chromium поддерживаются

указанные ниже actions.
• Закрыть
• Получить исходный код
• Назад
• Открыть
• Выполнить JavaScript

• Теперь в параметре Браузер можно из списка активных вкладок выбрать вкладки
Microsoft Edge.
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Control Room и Пакеты

Поддержка последней использованной вкладки браузера в action Браузер >
Открыть для Microsoft Edge и Google Chrome
Теперь можно открыть веб-страницу на новой или существующей вкладке с помощью
предустановки Последняя использованная вкладка браузера в указанных ниже
браузерах.
• Microsoft Edge
• Microsoft Edge в режиме IE
• Google Chrome

Время ожидания по умолчанию для загрузки страницы в браузере Microsoft Edge в
режиме IE
Когда вы автоматизируете какие-либо веб-приложения в браузере Microsoft Edge в режиме
IE, теперь Средство записи по умолчанию ожидает 30 секунд, чтобы дать веб-странице
полностью загрузиться перед записью каких-либо объектов на странице, тем самым делая
обнаружение объектов более надежным.

Особенности миграции

Сканирование боты которые используют Microsoft Internet Explorer
Теперь можно использовать Bot Scanner для сканирования и идентификации боты Internet
Explorer. Можно также проанализировать отчет, созданный Bot Scanner, чтобы получить
статистику использования об Internet Explorer, используемом в ваших боты.

Сканирование боты, которые используют Internet Explorer | Analyze report for Internet Explorer
боты | Сообщения о преобразовании или сканировании Internet Explorer
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Особенности миграции

Пакеты и actions
Теперь можно выполнять миграцию и преобразование боты Internet Explorer из Enterprise
11 или Enterprise 10 в Automation 360 с использованием Microsoft Edge в режиме IE для
указанных ниже пакеты и actions.
• Интеграция приложений
• Задержка
• IF/ELSE и Цикл
• Распознавание изображений
• Launch Website
• Manage Window Controls
• Экран MetaBot
• Мышь
• Object Cloning

Поддерживаются режимы Воспроизведение изображения и Воспроизведение
координат. В режиме Воспроизведение координат поддерживается действие щелчка
мыши с последующими нажатиями клавиш.

• Распознавание текста (OCR)
• Open Program/File
• Экран
• Имитация нажатия клавиш
• Ожидать

Поддержка actions Ожидать условие, Ожидать изменения экрана и Ожидать окно
• Средство веб-записи
• Windows Actions

Подробнее см. в разделе Сопоставление пакетов для миграции.
Для выполнения миграции и преобразования боты Internet Explorer перейдите в
раздел Администрирование > Миграция > Перенос ботов и выберите параметр
Преобразовать боты, созданные с помощью Internet Explorer, для работы в Edge в
режиме Internet Explorer в Control Room.
Указанные ниже свойства браузерных команд и actions, предназначенных для работы в
Internet Explorer, обновляются для работы в Microsoft Edge в режиме IE.
• Боты, созданные с использованием окна на базе браузера или приложения, заголовка окна

и пути к приложению
• Значение переменной окна по умолчанию, заголовок окна и путь к приложению окна

Прим.:  Боты, которые используют переменные типа значения, не обновляются для
работы в Microsoft Edge. Сначала необходимо включить настройки конфигурации в пакет
Legacy Automation, чтобы открыть боты, созданные с помощью Internet Explorer, в режиме
совместимости с Microsoft Edge.

• Переменные браузера и заголовок браузера
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Особенности миграции

Преобразование боты IE в Microsoft Edge в режиме IE
Когда вы выполняете миграцию своих боты с Enterprise 10 или Enterprise 11, можно
использовать новый параметр Преобразовать боты, созданные с помощью Internet
Explorer, для работы в Edge в режиме Internet Explorer в Bot Migration Wizard для
преобразования ваших боты, предназначенных для работы в Internet Explorer, в боты для
выполнения в Microsoft Edge в режиме IE.

Миграция корпоративных боты

Обновление истории и версий для перенесенных боты
В Bot Migration Wizard при миграции ваших боты Enterprise 10 или Enterprise 11 теперь
история версий обновляется, и в ней отражается, что это перенесенный бот (в комментарии
о загрузке указывается, что бот перенесен из версии Enterprise 10 или Enterprise 11).
Этот комментарий о загрузке можно использовать, чтобы определить, какая версия бот
перенесена.
Bot Migration Wizard

Исправления

The following fixes are available for Cloud, On-Premises, and Sandbox:

ID обращения к облачному
сервису

Описание

01784593 Теперь можно успешно запускать перенесенные боты,
даже если в поле Переменные пользователя в качестве
значения присутствует $ (знак доллара). В Bot Scanner больше
не отображается ошибка предварительной обработки.

-- При автоматизации веб-приложений, работающих в Microsoft
Edge Chromium в режиме IE или Internet Explorer, теперь
Средство записи создает снимок объекта из выбранной в
текущий момент вкладки браузера. Ранее Средство записи
создавало снимок объекта из последней использованной
вкладки.

01189873 After migration, when you use the Browser > Open action
to open a URL that has a space character, use the Browser >
Download files action to download the file from the specified
URL, and then run the бот, the бот now opens the URL in a single
tab and downloads the file from the specified URL.
Previously, when the specified URL had a space character, the бот
split the URL and opened it in two separate tabs.
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Известное поведение и ограничения

The following limitations apply to Cloud,On-Premises, and Sandbox:
• When you execute a stored procedure with name parameter arguments that resides in another

database in the Сервер SQL, the бот displays an error because of the JDBC driver issue with executing
a stored procedures with name parameters of another database in the same SQL instance.
Обходное решение. When you add parameters to provide an input parameter or configure an
output parameter, ensure you do not enter any value in the Parameter name field. The бот will not
encounter any error when executing the stored procedure because the База данных пакет considers
blank values as indexing.

• Обратите внимание, что даже если количество расписаний, перечисленных на странице
Расписания в Control Room меньше (например, пять или шесть расписаний), может выводиться
указанная ниже ошибка, вызванная истечением времени ожидания запроса. Возникла
непредвиденная проблема. Это существующая проблема, связанная с производительностью
базы данных Control Room.

• Существуют и другие ограничения и поведение, которые применяются к боты, перенесенным из
Enterprise 11 в Automation 360, и к боты Automation 360, которые запускаются в Internet Explorer
и преобразуются в Microsoft Edge в режиме IE. Подробнее см. в разделе Известное поведение и
ограничения.

• When you use the Browser > Close action to close a tab or a window opened in the Microsoft Edge
browser, if only one Microsoft Edge browser window is open, the бот encounters the following error:
Error occurred while closing the tab

Обходное решение. См. Configure Microsoft Edge browser settings when Close action of Browser package
encounters an error (A-people login required)

• When you use the Browser > Open action to open network URLs that start with two backslash (\\)
characters in the Google Chrome, Microsoft Edge, or Mozilla Firefox browser, the URLs might not open
properly.
Обходное решение. Replace the two backslash (\\) characters with file:// protocol.

• When you use the Browser > Open action, select New tab or Existing tab option to open a specific
webpage in Microsoft Edge with IE mode, the бот might throw an error after opening the webpage.
Обходное решение. Use any of the following workarounds based on specific scenarios:
• Option 1: Add Try/Catch block around the Open action and ignore the exception as the website

opens.
• Option 2: In the Browser > Open action, select the New window option instead for such

websites.

• When you use the New window option in the Browser > Open action with the 3.4.x version of the
Браузер пакет to open a URL with arguments, the бот might not perform the specific action as the
3.4.x version of the Браузер пакет does not support argument flags.
Обходное решение. Use any version other than the 3.4.x version of the Браузер пакет to
automate.

См. также указанные ниже ресурсы.
• Microsoft Internet Explorer EOL overview
• Microsoft Internet Explorer 11 EOL FAQ

Понятия, связанные с данным
Microsoft Internet Explorer 11 EOL FAQ
Microsoft has announced end-of-life (EOL) for Internet Explorer beginning June 2022 and recommends
using Microsoft Edge or Microsoft Edge in Internet Explorer (IE) mode. Это может повлиять на
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автоматизации (боты) (в зависимости от используемой в настоящее время операционной системы, в
которой запускаются боты).
Microsoft Internet Explorer EOL overview
Microsoft has announced retiring Internet Explorer (IE) for certain versions of Windows operating systems
and recommends impacted users to move their apps or websites running on IE to Microsoft Edge with IE
mode.
Информация, связанная с данной
Enterprise 11 and upcoming Internet Explorer 11 EOL FAQ

Заметки о выпуске Automation 360 v.24
Дата выпуска:08 апреля 2022 года
Оцените новые возможности, изменения, а также исправления и ограничения в выпуске Automation
360 v.24 (Сборка 12350).

Важное замечание:  Мы обновили Automation 360 v.24 (Сборка 12350), добавив исправления для
следующих проблем.
• Когда после миграции вы запускали перемещенные боты, они отображали ошибку для

переменных в двойных кавычках (" ") (ID обращения к облачному сервису: 01802575, 01803323,
01803800, 01804121, 01804820).

• Когда вы щелкали по значку AARI, то отображалась Control Room вместо экрана входа AARI
Assistant (ID обращения к облачному сервису: 01803979).

• Миграция
11.x и 10.x | Только 11.x | Только 10.x

• Рабочая область RPA

Новые возможности |  Изменения | Исправления | Ограничения
• AARI

Новые возможности |  Изменения | Исправления | Ограничения
• Discovery Bot

What's new | Fixes | Limitations | Feature Deprecation
• IQ Bot

Новые возможности | Исправления | Ограничения
• Bot Insight

Изменения | Исправления | Ограничения

Обновление до этого выпуска

Можно выполнить обновление до Automation 360 v.24 с трех предыдущих выпусков (то есть с
выпусков n−3, где n означает последний выпуск). Перечисленные ниже предыдущие выпуски
сертифицированы для обновления до этого выпуска:
• v.23 (сборка 11513)
• v.22 (сборка 10526)
• v.21 (сборки 9664, 9642, 9595)
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Вы можете напрямую выполнить обновление любой из этих сборок (см. Обновление до последней
версии Automation 360) до v.24. Если вы не используете выпуск n−3, перед обновлением до данного
выпуска обновите Automation 360 до одного из трех сертифицированных выпусков (перечисленных
выше).
• Если вы выполняете обновление до этого выпуска с Automation 360 On-Premises v.21, удалите

указанные ниже файлы и папки Bot Agent.
• C:\Windows\System32\config\systemprofile\AppData\Local\AutomationAnywhere

\AA-DB.mv.db
• C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-resources

• Перед обновлением Automation 360 On-Premises v.22 до этого выпуска ознакомьтесь с
рекомендациями по обновлению здесь: Обновление до последней версии Automation 360.

Важное замечание:  Этот выпуск включает в себя необязательное обновление Bot Agent. Для
использования новых функций в версии v.24 (включая обновления для миграции Бот, Браузер, DLL,
функции обнаружения процессов и пакеты Средство записи), обновите Bot Agent, доступный для
этого выпуска. Обратите внимание, что если вы хотите запустить существующие боты, обновление
Bot Agent до этого выпуска не требуется.

Информацию об обновлении до этого выпуска см. на указанных ниже ресурсах.
• Автоматическое обновление Bot Agent | Обновление Bot Agent вручную
• Compatibility with release builds

Для получения информации о последних обновлениях до расширений Automation 360 для Google
Chrome, Microsoft Edge и Mozilla Firefox см. раздел Browser extensions for Automation 360.

Important:  Этот выпуск включает новую команду пакеты, в которой библиотека Apache log4j2
больше не является объединенной. Однако более старая команда пакеты, начиная с Automation 360
v.23 и более ранних версий, может продолжать использовать объединенную библиотеку log4j2. Если
вы хотите использовать команду пакеты без объединенной библиотеки log4j2, мы рекомендуем вам
использовать в ваших задачах новую версию Automation 360 v.24 с командой пакеты.

Миграция

Особенности Enterprise 11 и Enterprise 10

Самостоятельная миграция Control Room
Теперь можно управлять процессом подготовки миграции с использованием возможностей
самостоятельной миграции. Можно также выбрать между ручной и автоматической
миграцией.

Самостоятельная миграция Control Room

Усовершенствование миграции переменных Credential Vault
Теперь миграция поддерживается, когда переменные Credential Vault передаются из одной
логики MetaBot в другую логику MetaBot для указанных ниже команд.
• ЕСЛИ > Логика успешна
• ЕСЛИ > Логика неудачна
• Начать обработку ошибок > Запустить логику
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Особенности Enterprise 11 и Enterprise 10

Теперь вы можете успешно перенести боты Enterprise 11, которые используют
32-разрядный wscript.exe, в 64-разрядную архитектуру без ошибок исключений. Это
усовершенствование поможет вам успешно выполнять VBScript.

Выполнение миграции MetaBot с родительской и дочерней логикой с
переименованной Логика
Теперь можно выполнить миграцию MetaBot с Логика (родительской), которая содержит
переименованную Логика (дочернюю). Если дочерняя Логика переименовывается после ее
сопоставления с родительской Логика, то это сопоставление родительской Логика теперь
переносится с новым именем.
Это усовершенствование относится к указанным ниже командам.
• ЕСЛИ > Логика успешна
• ЕСЛИ > Логика неудачна
• Else If > Логика успешна
• Else If > Логика неудачна
• Обработка ошибок > Запустить логику
• Запустить логику

Выполнение миграции, когда MetaBot и Логика имеют одинаковые имена
Теперь можно успешно выполнить миграцию своих Enterprise 11 боты, когда имя MetaBot
и папки активов или имя Логика внутри этой папки MetaBot совпадают. К имени Логика
добавляется суффикс -bot. Имя добавляется только в том случае, если Логика или папка
находится в той же иерархии, что и MetaBot.
• Если существующий бот содержит переименованную Логика или папку активов, то этой

Логика присваивается новое имя со следующим доступным номером. Например, -botn,
где n указывает на следующий доступный номер. Кроме того, отображается сообщение о
необходимости выполнения действия.

• Если MetaBot или Логика вызывает переименованную Логика или TaskBots, то путь
команды обновляется и включает в себя новое имя.

• Если имя Логика, MetaBot или папки с новым именем уже существует, то существующий
бот будет перезаписан.

Сообщения при выполнении миграции

Консолидированное представление перенесенных боты и их статуса
Используйте вкладку Обзор в Control Room для получения консолидированного
представления о статусе перенесенных боты. Просмотр общего статуса миграции бот для
всех боты, которые успешно перенесены, тех, которые не удалось перенести, и тех, которые
требуют проверки или действий. Также можно повторно запустить миграцию для выбранных
боты и просмотреть историю каждого бот, который прошел через несколько миграций.
Bot Migration Wizard
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Обновление переменных AAApplicationPath, CurrentDirectory и AAInstallationPath
Если ваш перенесенный бот содержит переменные $AAApplicationPath$, $CurrentDirectory$ или
$AAInstallationPath$ в каком-либо пути к файлу или папке, валидация абсолютного пути во
время миграции больше не выполняется. Кроме того, временная переменная ( $m-string-
start-in-path$) не создается и не назначается перенесенному бот для валидации.
В результате теперь размер перенесенного бот уменьшился, а производительность бот
повысилась.

Усовершенствование для миграции боты с помощью команды «Подключение
электронной почты»
При миграции Enterprise 11 боты которые содержат команды Подключение > электронной
почты и Отправка > электронной почты, настроенные для сервера EWS, в поле
Облако Azure установлено значение Azure глобальное и в качестве Типа проверки
подлинности установлен тип OAuth2 — бесшумный, который ранее назывался OAuth2.
Обратите внимание, что OAuth2 теперь поддерживает два режима: Бесшумный и
Интерактивный.
Using Connect action for Эл. почта

Миграция боты с временем ожидания, настроенным для отправки запросов REST и
SOAP
Значение времени ожидания, настроенное в Enterprise 11 для отправки запросов REST и
SOAP, теперь перенесено в Automation 360 в составе глобальных значений (AARestTimeOut
и AASoapTimeOut). Для времени ожидания в Automation 360 по умолчанию установлено
значение 60 000 мс. Это значение можно обновить, если Веб-служба REST для получения
ответа потребуется больше времени.

Веб-служба REST пакет | Пример использования действия веб-службы SOAP

Только для Enterprise 10

Миграция новых или измененных боты Enterprise 10 в Automation 360 (ID
обращения к облачному сервису 00719524)
Теперь можно выполнять миграцию новых или измененных боты Enterprise 10 в Automation
360 после предыдущей миграции. Теперь доступна новая утилита экспорта, которая
позволяет экспортировать такие новые и измененные боты из репозитория Control Room
Enterprise 10. Затем можно позже импортировать экспортированные боты в Automation 360,
используя Bot Lifecycle Management (BLM), после чего окончательно перенести их, используя
Bot Migration Wizard.

Миграция новых или измененных боты Enterprise 10 в Automation 360
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Новые возможности

Обновления Bot Agent и ранняя доступность пакеты
Начиная с этого выпуска, вы можете выбрать или пропустить некоторые обновления
Bot Agent и начать использовать пакеты, как только новые версии пакет становятся
общедоступными независимо от вашего региона.
Обновления Bot Agent, поддерживающие новые пакеты или обновления для пакеты, будут
выходить ежеквартально, при этом будут чередоваться обязательные и необязательные
обновления.
Ранее обновления Bot Agent становились автоматически доступными для всех групп
пользовательских устройств, не влияя на выполнение бот. В некоторых крупных и сложных
сценариях развертывания эти обновления могли вызывать проблемы, но их нельзя было
пропустить. (В качестве примеров можно привести развертывания, в которых группы
устройств развертывались с использованием стандартных образов Amazon Machine Image
(AMI) для устройств по отдельным расписаниям, что требовало улучшенной координации,
процессов управления изменениями и утверждения в пользовательской среде для
обновления Bot Agent.) Теперь вы можете пропустить необязательное обновление и
установить следующее обязательное обновление Bot Agent, так как Automation 360 начнет
обеспечивать обратную совместимость с Bot Agent для каждых полугодовых выпусков.
Кроме того, с каждым выпуском вы можете начать использовать последнюю версию пакеты,
как только выходят новые версии пакет. Для пользователей Automation 360 Cloud обновления
пакет теперь становятся доступными асинхронно во всех регионах, так что вы можете
начать использовать новую версию пакеты в текущей версии Control Room еще до того, как
обновление Control Room станет доступно для вашего региона.
Compatibility with release builds

Создание пользователей с несколькими именами для входа
Теперь можно создать пользователя с несколькими именами для входа. Пользователю с
несколькими именами для входа разрешено выполнять несколько сеансов доступа к Control
Room через API.

Пользователь с несколькими именами для входа |

Больше возможностей с Microsoft Edge Chromium
Теперь можно использовать расширение браузера Microsoft Edge Chromium для указанных
ниже операций.
• Конфигурация прокси Bot Agent
• Автоматическое заполнение учетных данных устройства

Требования к браузеру для доступа к Рабочая область RPA

Сокращение времени решения проблем
Теперь можно сократить время сбора информации о проблемах путем записи файлов
журнала с устройства Bot Runner. Файлы журнала можно сохранить, используя новую
команду -collectlogs с утилитой диагностики Bot Agent.

Выполнение диагностических проверок Bot Agent
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Влияние изменения политики Google Chrome на Bot Agent
Начиная с Google Chrome версии 101, в Google Chrome версии 101) отменяется прямой
доступ к конечным точкам частной сети с публичных веб-сайтов в рамках спецификации
Private Network Access (PNA) и с URL-адресов, использующих протокол https. Чтобы
оптимизировать работу, начиная с этого выпуска в Bot Agent добавлены заголовки ответов,
которые позволяют Bot Agent взаимодействовать с Control Room в браузерах Google Chrome.
Это обеспечит выполнение таких операций, как регистрация устройства, а также запись,
воспроизведение или развертывание бот. Данные аспекты не будут затронуты изменением.

Усовершенствование AISense Recorder
Теперь можно использовать AISense Recorder для автоматизации приложений, использующих
японский язык и сочетание японского и английского интерфейсов.
AISense для записи задач из удаленных приложений

Параметр времени ожидания в Веб-служба SOAP и пакеты Веб-служба REST (ID
обращения к облачному сервису: 00756730, 00792793, 01255869, 01753287)
Теперь при создании бот можно установить значение времени ожидания для actions в
запросах REST и SOAP. Чтобы указать, как долго бот должен ждать ответа от сервера до
истечения времени ожидания, можно установить время ожидания (в миллисекундах) в поле
Время ожидания завершения действия. Можно ввести число или переменную или
указать глобальное значение.

Форматирование текста с помощью нового HTML-редактора в пакет Эл. почта
В пакет Эл. почта, когда используются действия Отправить, Ответить и Переслать actions,
теперь можно создавать и настраивать макет и тело письма с помощью нового редактора
дизайна HTML. Используйте панель инструментов редактора для внесения различных
изменений в текст, например применения полужирного шрифта, курсива и других эффектов
форматирования, вставки ссылок, изменения шрифта и размера текста. Содержимое можно
скопировать из редактора дизайна и вставлять его в другие окна.

Теперь TaskBotпакет поддерживает передачу переменной «Окно» в дочерний бот
(ID обращения к облачному сервису: 00691890, 00804359, 01258948, 01764292)
В action Запустить для пакет TaskBot, когда вы выбираете поля Входные значения и
вводите значения или переменные для передачи в дочерний бот, теперь можно выбрать
переменную типа Window и передать ее из родительского бот в дочерний бот.

Новая опция в поле «Тип содержимого» пакет Веб-служба REST (ID обращения к
облачному сервису: 00666852, 00789910, 00771194, 00785116, 00825945, 01762199)
Теперь можно использовать multipart/form-data для загрузки файлов и данных с
использованием Веб-служба REST. Для отправки элементов формы, содержащих файлы,
данные, отличные от ASCII, и двоичные данные, можно использовать тип содержимого
multipart/form-data. Эта опция доступна для таких actions, как POST, PUT и PATCH.

Опция пользовательского разделителя в пакет Веб-служба SOAP
Для ответов, специфичных для XPath, теперь можно использовать опцию пользовательского
разделителя для разделения содержимого, возвращаемого из ответа SOAP. В поле
Пользовательский разделитель можно ввести символ или переменную, и вывод
разделенного ответа будет полной строкой.
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Новый параметр в action «Выполнить функцию» для пакет DLL (ID обращения к
облачному сервису: 00830568, 01063654, 01259336, 01767965)
В ходе выполнения action Выполнить функцию для пакет DLL, когда DLL C#
взаимодействует с API-интерфейсом Windows для выполнения системных операций, таких как
нажатие клавиш, щелчок кнопкой мыши или переключение окон, периодически отображается
промежуточное окно (AAZeroSizeForm), которое прерывает работу пользователя во время
выполнения бот. В некоторых случаях функция DLL не взаимодействует с API-интерфейсом
Windows для выполнения таких actions, как нажатие клавиш, щелчок кнопкой мыши,
переключение окон, в пользовательском интерфейсе операционной системы при
использовании функции DLL. В таких случаях можно установить флажок Выполнять
функцию в фоновом режиме, чтобы избежать появления промежуточного окна
(AAZeroSizeForm) и запустить DLL C# в консольном приложении без формы. Эта функция
также помогает повысить производительность выполнения DLL, если установлен флажок
Выполнять функцию в фоновом режиме.

В Bot editor поддерживается автопрокрутка (ID обращения к облачному сервису:
00730747)
При создании или редактировании боты с большим количеством строк кода и при
перетаскивании actions вверх или вниз по странице, теперь страница автоматически
прокручивается соответственно вверх или вниз. Эта функция поддерживается в обоих
представлениях: Поток и Список.

Настройка времени ожидания сеанса в настройках Control Room  (ID обращения к
облачному сервису: 00765320)
Теперь можно гарантировать, что ваш веб-сеанс не будет прекращен из-за истечения
времени ожидания, например, при создании бота. Для этого следует настроить подходящую
продолжительность времени ожидания сеанса в настройках Control Room. В зависимости от
настроенной продолжительности времени ожидания сеанс будет прекращаться только по
истечении указанного количества минут неактивности, что предотвращает потерю работы
из-за преждевременного прерывания сеанса, вызванного истечением времени ожидания.

Новый пакет JSON
Используйте пакет JSON для автоматизации работы с данными JSON. Теперь можно извлекать
необходимую информацию из текста или файла JSON и напрямую использовать значения в
бот.

пакет JSON

Новая опция в action «Выявить» пакет Обработчик ошибок (ID обращения к
облачному сервису: 00766117)
Теперь в пакет Обработчик ошибок можно игнорировать ошибки в ходе выполнения actions
внутри блока Выявить. Для этого следует использовать флажок Выявить > При ошибке
выполнить следующее действие. При установке флажка При ошибке выполнить
следующее действие, даже если в ходе выполнения action в блоке Выявить произошла
ошибка, исключение не будет выдаваться и бот проигнорирует ошибку и перейдет к
следующему действию.

Прим.:  Это усовершенствование применяется ко всем вложенным actions в блоке Выявить .
Например, если у вас есть action Попробовать/Выявить внутри основного action Выявить
и установлен флажок в основном action Выявить, любая ошибка в ходе выполнения actions
из вложенного блока также будет игнорироваться.
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Усовершенствования action Подключить в пакет Эл. почта (ID обращения к облачному
сервису: 00830611, 01264796, 00788467)
• Теперь можно подключиться к серверу EWS, размещенному в облаке Azure US GCC high.
• Теперь action позволяет пользователям федерированного Azure подключаться к серверу

EWS в режиме автоматизации с сопровождением.

Using Connect action for Эл. почта

Усовершенствование пакет «Строка»
В action Извлечь текст в пакет «Строка», когда вы используете параметр После или
До и (или) после, вы можете извлечь подстроку из указанной исходной строки, которая
встречается в файле от 1 до 999 999 раз.

Поиск файлов по определенной дате
Теперь можно искать файлы, созданные или измененные в определенную дату, с помощью
нового параметра По дате, доступному в условии Дата файла различных пакеты.
Вы можете использовать эту функцию с указанными ниже пакеты и actions.
• Файл пакет

• action Копировать файлы рабочего стола
• Удалить action
• Печать action
• Печать нескольких файлов action
• Переименовать action

• Папка пакет
• Копировать action
• Удалить action
• Переименовать action

• Если > Условие даты файла
• Цикл > While > Условие даты файла

Новое action в Расширенный Excel пакет (ID обращения к облачному сервису: 01263892,
01782290)
Теперь при выполнении actions на листе Microsoft Excel можно выключить или включить
обновление экрана в реальном времени с помощью нового action Выключить или
включить обновление экрана в реальном времени в пакет Расширенный Excel. Это
action полезно для повышения производительности автоматизаций на базе Excel во время
выполнения при работе с большими наборами данных.
Worksheet operations in Расширенный Excel

Поддержка копирования метаданных из одного бот в другой
Теперь можно копировать файлы изображений и метаданных из одного бот в другой с
помощью параметра Копировать в общий буфер обмена.
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Дополнительные возможности извлечения документов в боты
Теперь можно выполнять подключение боты к учетной записи службы Google Cloud,
отправлять документы в определенный обработчик и получать извлеченные данные в
формате JSON с помощью actions в Google Document AI пакет.
Google Document AI пакет

Используйте условия Средство записи в Microsoft Edge на базе Chromium в режиме
Internet Explorer (IE)
Теперь можно использовать условия Средство записи Объект существует и Объект не
существует в браузере Microsoft Edge на базе Chromium в режиме IE для указанных ниже
пакеты.
• Цикл > Условие While
• Ожидать > Ожидать условие
• Если пакет

Использование пользовательских форматов даты и времени
Используйте приведенные ниже соглашения для указания пользовательских форматов
даты/времени и преобразования значения даты/времени.
• D. Укажите день в году в формате D или DD.
• a. Укажите маркер AM/PM для 12-часового формата времени.

Datetime formats

Поддержка браузера Internet Explorer для пакет Браузер и переменных окна
• Следующие actions в Браузер пакет теперь поддерживаются в браузере Internet Explorer:

• Открыть
• Закрыть
• Назад
• Получить исходный код

• Теперь в параметре Браузер можно из списка активных вкладок выбрать вкладки Internet
Explorer.

Браузер пакет

Усовершенствование пакет Дата/время
Параметр Переменная в action Дата/время > Присвоить теперь расширен и разделен на
два параметра:
• Дата/время Позволяет выбрать дату и время вместе с часовым поясом вручную и

присвоить их переменной «Дата/время».
• Переменная. Позволяет выбрать переменную Дата/время или другие переменные,

которые могут иметь Дата/время в качестве подтипа, например, переменные «Словарь»,
«Запись» и «Список».

Использование действия «Присвоить»
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Усовершенствование пакет Средство записи
Теперь вы можете делать снимки объектов и автоматизировать объекты внутри
междоменного IFrame, который содержит несколько элементов IFrame с одним и тем же
источником кадров, а также элементы IFrame, которые загружаются во время выполнения
в браузерах Google Chrome и Microsoft Edge Chromium. Это можно сделать это с помощью
параметра Средство записи > Запись или Начать запись. Эта поддержка также доступна
для автономных расширений Google Chrome.

Пакет Средство записи

Поддержка всплывающих окон и диалоговых окон в браузерах Google Chrome,
Microsoft Edge Chromium и Mozilla Firefox (ID обращения к облачному сервису: 00762207,
00769773, 00781196, 00786646, 00777907, 00795677, 00785995,00808600, 00811044, 00767486,
01282172, 01286665, 01256750, 01762040)
Теперь при автоматизации веб-страницы в поддерживаемых браузерах можно захватывать
всплывающие окна, диалоговые окна предупреждений, диалоговые окна подтверждения
и диалоговые окна с запросами, которые появляются. Это можно сделать это с помощью
параметра Средство записи > Запись или Начать запись.

Пакет Средство записи

Получение исходного кода iFrame в браузере Google Chrome
Теперь можно получить исходный код iFrame в браузере Google Chrome, используя action
Браузер > Получить исходный код. Для создания снимков этих элементов iFrame можно
использовать новый параметр  Сделать снимок объекта.

Прим.:  Функция Сделать снимок объекта является необязательной и используется только
для получения исходного кода iFrame.

Запуск JavaScript внутри iFrame в браузере Google Chrome
Теперь можно запустить JavaScript на странице, содержащей элементы iFrame, в браузере
Google Chrome, используя action Браузер > Выполнить JavaScript. Можно использовать
новый параметр Сделать снимок объекта для создания снимков элементов iFrame, для
которых вы хотите запустить JavaScript.

Прим.:  Функция  Сделать снимок объекта является необязательной и используется
только для выполнения JavaScript внутри iFrame.

Поддержка глобальных сеансов для пакет Базовый Excel
• Теперь для пакет Базовый Excel поддерживается параметр глобального сеанса.

Применяйте параметр «Глобальный сеанс» для совместного использования сеанса
Microsoft Excel для нескольких боты, что позволяет использовать один и тот же лист Excel
для всех этих боты.

• Теперь поле Имя сеанса переименовано в Создать сеанс Excel.

Using the Open action for Базовый Excel
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Новые возможности

Переменная по умолчанию для хранения данных числового типа
Теперь при создании или тестировании бот можно использовать числовую переменную по
умолчанию SampleNumber, включенную в палитру «Переменные».

Прим.:  Числовая переменная по умолчанию доступна только в новых боты.

Экспорт и импорт файлов, защищенных паролем
Теперь функции экспорта и импорта дополнены опцией пароля, что позволит повысить
безопасность, обеспечивая защиту от несанкционированного доступа и вредоносного
редактирования, а также защитить конфиденциальность. С помощью этой функции можно
выполнять указанные ниже действия.
• Установите пароль для файлов, которые собираетесь экспортировать из вашей Control

Room.
• Импортируйте защищенный паролем экспортированный файл в свою Control Room.

Экспортировать боты | Импорт боты

Новые возможности в конфигурации Git (ID обращения к облачному сервису: 00782957,
00837059, 00687394, 00783715, 00714059, 00659476, 00749755, 00786233, 00748166,
00776417)
Теперь для конфигурации Git можно выполнять указанные ниже действия.
• Выбрать метод проверки подлинности HTTPS или SSH для настройки конфигурации

Git. Метод проверки подлинности SSH является более безопасным, поскольку проверка
подлинности основана на паре открытого и закрытого ключа.

• Указать ветвь, в которую собираетесь перенести свои фиксации Git. Это помогает
координировать работу группы и управлять потоком операций.

• Подключитесь к своему репозиторию Git с помощью прокси-сервера.

Configure a remote Git repository in Control Room | Restore боты from Git repository

Принудительная передача (force push) как настройка конфигурации для
интеграции с Git в Control Room (ID обращения к облачному сервису: 00683762)
Теперь можно настроить передачу Git (Git push), как с флагом force push, так и без него.
Ранее обновление удаленного Git из Control Room функционировало исключительно как force
push. Такая настройка force push является рекомендуемой и оптимальной настройкой.

Поддержка Azure DevOps (On-Premises или Cloud) Git для проверки подлинности
SSH (ID обращения к облачному сервису: 00652012, 00690526)
Теперь можно использовать проверку подлинности SSH или HTTPS для подключения к Azure
DevOps (On-Premises или Cloud) Git через Control Room, чтобы загрузить бот и зависимые
файлы в удаленный репозиторий Azure DevOps Git.
Connect to Azure DevOps Git from Control Room

Уязвимость в ядре Spring — CVE-2022-22965 (01793279, 01793398, 01793497, 01793679,
01794189)
Обновление до Spring Framework, которое содержит исправление для уязвимости CVE -—
CVE-2022-22965.
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Изменения

Проверки миграции для настроек устройства по умолчанию
Теперь в процессе валидации предварительных условий для миграции проверяется,
установлено ли устройство по умолчанию для Bot Runner, выбранных для миграции бот.
Если устройство по умолчанию не установлено, то миграция бот не может быть продолжена,
и в отчете о валидации указывается ошибка валидации. В отчете также отображаются
конкретные устройства Bot Runner, для которых не установлены устройства по умолчанию.
Обратите внимание что при миграции бот нельзя использовать устройства, выбранные во
время выполнения.

В отчете о миграции Бот отображается перенесенный бот с указанием
необходимых действий и проверок
Теперь в отчете о миграции бот отдельно перечисляются боты, для которых после миграции
могут потребоваться действия или проверки. Эта функция позволяет просматривать
список боты, для которых требуются действий или проверки, и соответствующим образом
планировать шаги после миграции.

Миграция боты 11.x с прямой косой чертой в пути к файлам и папкам (ID обращения
к облачному сервису 00808534)
Теперь можно выполнить миграцию боты Enterprise 11, которые содержат прямую косую
черту в пути, используемом в action Файл и папка. Ранее в пути поддерживалась только
обратная косая черта, поэтому пользователь не мог создать папку на SharePoint.

Теперь можно выполнять миграцию боты Enterprise 11 вручную, даже когда папка My
 MetaBots отсутствует в Control Room, потому что эта папка больше не валидируется во
время миграции.

Улучшенное управление пользователями
Теперь вы можете просматривать действия боты, запущенные другими пользователями из
папок, для которых у вас есть разрешения на запуск и планирование.

Усовершенствование настройки срока действия API-ключа (ID обращения к
облачному сервису: 00543590, 00719480, 01373359)
Теперь можно увеличить срок действия API-ключей до 9999 дней, используя настройки
Control Room для аутентификации. Ранее срок действия API-ключей составлял 45 дней.
Благодаря этому усовершенствованию администратору Control Room не нужно каждые
45 дней заново генерировать API-ключ для аутентификации API-интерфейсов Automation 360.

Повышенная безопасность в пакет Распознавание изображений
Теперь при использовании любого actions Распознавание изображений из пакет
Распознавание изображений обеспечивается повышенная безопасность. Теперь регистрация
изображений в журнале отключена, для того чтобы в случае сбоя бота во время выполнения
одного из actions Распознавание изображений записанные исходные и целевые изображения
больше не сохранялись в папке журнала.
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Изменения

Усовершенствование фильтра по темам в пакет Эл. почта (ID обращения к облачному
сервису: 00776374, 00953823, 975605)
При подключении к серверу Exchange Web Services (EWS), чтобы повторить набор действий
для всех сообщений электронной почты, которые соответствуют набору критериев,
используйте action Переместить все в пакет Эл. почта или используйте Цикл > Итератор
> Для каждого сообщения в почтовом ящике. Теперь данные в поле Если тема
содержит необходимо вводить с учетом регистра При вводе текста внутри пары двойных
кавычек ("") в поле Если тема содержит бот извлекает все сообщения электронной почты,
тема которых в точности совпадает с текстом, введенным внутри пары двойных кавычек, и
используемым для этого текста регистром.

Изменение имени переменной по умолчанию
Теперь имя переменной строкового типа по умолчанию изменено с prompt-assignment на
SampleString.

Прим.:  Это изменение затрагивает только новые боты.

Изменение информации о действиях на странице «История»
Информация о выполняемых действиях бот извлекается за последние 90 дней на странице
действий История Control Room. Информацию о действиях, которые выполнялись более
90 дней назад, можно просмотреть в журналах аудита.

Просмотр выполненных действий

Улучшенное управление режимом безопасной записи
Если вы являетесь администратором, теперь вы можете включить или выключить режим
безопасной записи на основе назначенных функций (разрешений) пользователей для более
детального управления Control Room.

Безопасная запись

В приведенной ниже таблице перечислены исправления, а также сборка, в которой была
исправлена каждая проблема. Сборка 12350 является последней сборкой и включает в себя
исправления из предыдущих сборок.

Исправления

Сборка ID обращения к
облачному сервису

Описание

12350 01768021, 01803781 После обновления Control Room больше не
реагирует на запросы и работает нормально. Ранее
Control Room не реагировала на запросы после
обновления из-за блокировок Java.
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Исправления

Сборка ID обращения к
облачному сервису

Описание

12350 01802575,
01803323,
01803800,
01804121, 01804820

После обновления с предыдущего выпуска до этого
выпуска при запуске боты перенесенные боты
больше не отображают ошибку для переменных
в двойных кавычках (" "). Вам не нужно удалять
двойные кавычки в качестве обходного пути для
запуска боты.
Например, после обновления с Automation 360 v.23,
вы можете запустить бот с пакет Расширенный
Excel, где содержится следующая переменная:
"$HeaderCounter$"

12342 00827504,
00788652,
00827730, 01259452

Имея необходимые разрешения, вы теперь можете
просматривать правильную информацию на
странице Завершенные действия. Ранее ошибка
«Недостаточно разрешений» иногда не позволяла
даже пользователям с административными правами
просматривать некоторые записи на странице
Завершенные действия.

12342 00823799, 01623586 При миграции MetaBots Enterprise 11 с типами
параметров переменных «Ввод», «Вывод» и
«Нет», они теперь правильно сопоставляются с
соответствующим типом параметра в Automation
360 после миграции.
Ранее типы переменных Enterprise 11
«Ввод», «Вывод» или «Нет» после миграции
сопоставлялись с типом «Ввод/вывод».

12342 00819756 Когда после миграции вы запускаете бот с
действием Переключиться на лист и это
действие выполняется, лист становится видимым и
активируется для дальнейших операций.

12342 01773270, 01781001 Теперь Утилита миграции в облако может
успешно подключаться к базе данных, даже если
учетные данные базы данных содержат следующие
специальные символы:
& # @ % $

12342 00988580, 01200161 Теперь после миграции с Enterprise 11 на
Automation 360 можно Выгрузить боты и
зависимые файлы в рабочую область Control Room
Общие.
Ранее зависимые файлы были недоступны для
действия Выгрузить в рабочей области Control
Room Общие. Чтобы зависимые файлы могли
автоматически клонироваться и стать доступными
для действия Выгрузить, сначала необходимо
выгрузить родительские боты.
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Исправления

Сборка ID обращения к
облачному сервису

Описание

12342 00788046 При запуске бот с параметрами Ожидание, Файл,
Папка в качестве Действий или с Условиями
Если/Цикл, если для параметров Дата начала
и Дата окончания установлена одна дата, боты
выполняют соответствующее действие или условия
на основе установленной даты окончания.

12342 01598462 Теперь команда Запустить логику работает
правильно, когда MetaBots содержат Логика с
различными параметрами, назначенными каждой
Логика. Если отключить одну Логика в MetaBot,
то другая Логика и ее команда будут работать
правильно.
Ранее, если отключалась одна Логика в MetaBot,
отключались и команды, относящиеся к другой
Логика.

12342 01251985,
01264753, 01272804

Теперь в пакете SAP BAPI команда Получить
таблицу для подтипа Таблица успешно извлекает
результаты для параметров Импорт, Экспорт и
Таблица.
Ранее выполнение команды Получить таблицу
для подтипа Таблица с параметрами Импорт или
Экспорт завершалось сбоем.

12342 01262390 При миграции боты Enterprise 11, которые
используют условие ЕСЛИ > Файл существует с
подстановочным знаком в имени файла, они теперь
выполняются успешно независимо от наличия
родительской папки в пути.
Ранее при отсутствии родительской папки в пути
условия бот прекращал работу и выдавал ошибку.
Если вы используете этот или более ранний
выпуск, можно использовать условие ЕСЛИ >
Файл существует с родительской папкой, наряду
с текущим условием ЕСЛИ > Файл существует с
подстановочным знаком.

12342 -- В мигрированном, который включает в себя
команду Файл и папка, флажок Включить даты
начала и окончания установлен по умолчанию.
В результате в боты Enterprise 11 при выполнении
операции переименования файлов больше не
происходит сбоя в Automation 360, даже если
указанные даты начала и окончания совпадают при
сравнении с использованием условия Между.
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Исправления

Сборка ID обращения к
облачному сервису

Описание

12342 01751462 Когда команда Выполнить задачу с путем
к переменной отключена, а переменная,
используемая в пути, удалена, теперь миграция
TaskBot может быть выполнения без ошибок. Ранее
миграция завершалась сбоем и отображалась
ошибка предварительной обработки.

12342 00824337 В результате переноса больше не отображается
сообщение об ошибке, когда выполняется миграция
бот с именем учетных данных на японском языке.

12342 00783883 Теперь action на основе HTML-технологии
(например GetProperty) поддерживает механизм
повторной попытки, что позволяет переносить
боты, которые включают команду средства записи
с внутренним текстом.

12342 -- Теперь можно успешно переносить боты Enterprise
11, которые имеют отрицательные значения
координат x и y для верхнего и левого полей.

12342 00827997 Теперь Bot Scanner позволяет переносить боты
с несколькими условиями выражения, которые
включают отключенную строку кода, и ошибка
больше не отображается.

12342 00834597 Теперь Bot Scanner успешно анализирует
экран MetaBot и больше не выдает ошибку
предварительной обработки исходного файла.

12342 01213241 Теперь все подключаемые модули успешно
загружаются при открытии листа Excel с помощью
action Excel > Открыть.

12342 01504682 Bot Scanner больше не выдает внутреннюю
ошибку, даже если бот содержит любой из этих
специальных символов: &#26.

12342 -- Теперь можно успешно выполнить миграцию боты
Enterprise 10, которые имеют функции разрешений
папки. Ранее такие разрешения не переносились.

Прим.:  Функция Запуск и планирование не
переносится.

12342 01632298 Теперь можно выполнить миграцию боты с
переменной Аналитика через Bot Migration
Wizard, после миграции отображается статус
«Успешно». Ранее эти боты «зависали» в состоянии
В процессе выполнения и поэтому боты не
запускались.
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Исправления

Сборка ID обращения к
облачному сервису

Описание

12342 00828781,
01258567,
01273170, 01469879

Теперь Боты завершают свое выполнение
быстрее, чем раньше, когда прокси включен с
использованием файла PAC в развертываниях
Cloud.

12342 01385567, 01749465 В Control Room теперь правильно отображается
информация для параметра Отображать сайты
интранета в представлении совместимости
в разделе Настройки представления
совместимости. Ранее в версии Automation 360
v.23 из-за внутренней проблемы отображалась
пустая страница.

12342 00807226, 01148097 Если IP-адрес подсети содержит число 80
(например, 192.30.80.25), теперь для порта
Control Room можно настроить значение 80 в
установщике.
Ранее, если адрес подсети содержал число 80, для
порта Control Room невозможно было настроить
значение 80. Для IP-адреса необходимо было
настроить другой номер порта, не содержащий
число 80.

12342 00836549 При копировании функции с помощью действия
Создать функцию в Control Room разрешения
пользователя и бот теперь сохраняются правильно.
Ранее редактирование связанной функции
приводило к потере всех связанных с ней
разрешений бот.

12342 01434341,
01755003,
01755713,
01756244,
01757083,
01756871, 01758346

Теперь можете успешно выполнять поиск японских
символов в ботах, используя поле поиска «Найти
в этом боте». Ранее японские символы вводились
с клавиатуры неправильно и для поиска японских
символов приходилось использовать обходной
путь.
Japanese language search support

12342 -- Если вы Загружаете бот в рабочую область
Control Room Общие после фильтрации данных
о зависимостях, при экспорте бот теперь
отображаются только отфильтрованные данные.
Ранее, даже после фильтрации данных о
зависимостях, отображались все данные.

12342 00819477 Теперь можно просматривать зависимые файлы
при открытии бот в редакторе бот. Ранее
зависимые файлы отображались только в режиме
просмотра.
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12342 -- Когда имя пула устройств включает символ
подчеркивания (_), установщик MSI теперь
выполняет авторегистрацию свойств пула
устройств, в результате чего происходит
заполнение имен пулов устройств с символами
подчеркивания. Ранее установщик MSI не
выполнял авторегистрацию устройства, если пул
устройств включал символ подчеркивания.

12342 01758029,
017596611

Теперь можно использовать аутентификацию
Azure AD для подключения к серверу базы данных
Azure при установке Control Room с помощью
установщика Windows и сценария установки. Ранее,
если в окне «Сервер базы данных» была выбрана
аутентификация Azure AD, установка Control Room
завершалась сбоем.

12342 -- После установки или обновления Automation 360
с предыдущего выпуска на странице Control Room
Сводка по установке теперь отображается
правильный номер версии. Ранее на странице
отображался неправильный номер версии.

12342 00796190,
00827493, 01251725

Теперь при развертывании бот в окне среды
выполнения отображается правильный номер
строки и имя пакет для action Захватить рабочий
стол пакета Обработка ошибок. Вы можете найти
точный номер строки, которая вызвала ошибку,
используя переменную в параметре Обработчик
ошибок: Выявить > Назначить номер строки.

12342 00800990 Теперь можно переименовать бот, изменив
верхний регистр символов на нижний или с
половины ширины символов на полную ширину.
Например, можно переименовать бот с Automate
на automate.
Ранее изменить текст в имени бот было
невозможно. При попытке изменения текста
появлялось приведенное ниже сообщение об
ошибке.
Не удается создать файл с именем
<filename>.Это имя уже используется.Для
продолжения переименуйте свой файл.Код:
repository.exception.file.exists
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12342 01258242 Если вы запускаете бот, содержащий несколько
условий и отсутствующий оператор в одном из
условий, с использованием Bot editor, теперь
отображается сообщение об ошибке, связанной с
отсутствующим оператором. Если вы обновляете
action и сохраняете изменения, а оператор
отсутствует, теперь по умолчанию добавляется
оператор И. Ранее выполнение боты с несколькими
условиями периодически завершалось ошибкой
препроцессора.

12342 00805738 Теперь отображается сообщение об ошибке и вы
больше не можете загружать или выгружать файлы
с идентичными путями к файлам (за исключением
различий в регистре символов). Ранее, когда путь
к файлу содержал символы в разных регистрах
и файл загружался или выгружался, во время
развертывания бот возникали проблемы.

12342 01753711 При выгрузке папки, содержащей задачи с
зависимостями, проблем больше не возникает.
Ранее в операциях сравнения строк возникали
проблемы, связанные с регистром, что приводило к
ошибкам в операциях загрузки и выгрузки.

12342 01271474, 01761856 При назначении метки производства дочернему
бот, который имеет более одной версии, во время
операций бот будет отображаться рабочая версия.
Ранее вместо рабочей версии отображалась
последняя версия дочернего бот.

12342 01270601,
01260628,
01255632,
01758499,
01775489,01773778

Когда вы подключаетесь к Microsoft Outlook,
IMAP или POP3, вы теперь можете создать папку
бот и сохранять все электронные письма в папке,
даже если в теме письма содержатся символы
косой черты (/) или обратной косой черты (\). При
сохранении электронных писем символы косой
черты (/) и обратной косой черты (\) в строке темы
теперь заменяются символом подчеркивания (_).

12342 01755993,
01782945,
01775161, 01792954

In the Эл. почта пакет when you connect to Microsoft
Outlook to automate an email-related task, you
can now use the Move all action followed by Loop
action to move unread emails from one folder to
another folder. Раньше, когда вы запускали бот,
то бот не удавалось переместить непрочитанные
электронные письма из-за ошибки.
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12342 01264563 Теперь можно создать бот, используя параметр
Глобальный сеанс в action Открыть в пакет DLL
и выбрав Сеанс DLL не существует для условия
Если. Ранее возникала ошибка, когда action
Открыть в пакет DLL и условие Если (Сеанс DLL
не существует) последовательно вызывались
несколько раз.

12342 01258059 В пакет XML при создании бот для получения
данных с использованием action Получить один
узел и при наличии в XML-файле нескольких
закомментированных строк эти строки в
выводе больше не отображаются. Ранее в
выводе отображались строки, которые были
закомментированы.

12342 -- В Веб-служба SOAP при выборе Параметра с
необработанными данными и использовании
параметра Создать Xpath можно успешно извлечь
значения из ответа SOAP и сохранить выходные
данные XML в переменной. Ранее извлекать
значения из ответа SOAP было невозможно, потому
что параметр Создать Xpath не работал должным
образом.

12342 01071731, 01762875 При открытии файла CSV или TXT, чтении данных
из этого файла и записи данных в файл из
переменной типа Table больше не происходит
сбоев в работе бот, если файл CSV или TXT
содержит большие наборы данных. Теперь
бот успешно выполняется, даже когда в action
Записать в файл установлены флажки Создать
папки/файлы, если они не существуют и
Заменить существующий файл.

12342 00968574 Больше не возникает ошибка при создании бот с
использованием action Открыть в пакет VBScript
и выборе файла VBScript с рабочего стола с
расширением файла, написанным символами в
верхнем регистре. Ранее, если расширение файла
было написано символами в верхнем регистре,
бот не выполнялся, поскольку этот файл считался
недопустимым файлом сценария.

12342 00831463 Теперь с помощью пакет Эл. почта можно
отправлять сообщения электронной почты с
темой сообщения, содержащей комбинацию
японских символов половинной ширины и символов
катаканы. Ранее, если тема письма содержала
комбинацию японских символов половинной
ширины и символов катаканы, в полученном
сообщении текст отображался в искаженном виде.
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12342 00822222 Когда вы подключаетесь к серверу EWS для
автоматизации задач, связанных с электронной
почтой, теперь вы можете отправлять несколько
сообщений электронной почты без указания
значения в поле темы при использовании action
Отправить сообщение электронной почты
в цикле. Ранее, когда в поле темы было пустое
значение, бот не мог прочитать такие сообщения.

12342 00823283 В пакет FTP / SFTP больше не возникает ошибка,
когда в action Получить папки имя папки
указывается в виде точки (.). При выполнении бот
он загружает все папки из текущего каталога в
локальный путь к папке, указанный в действии.

12342 00824379 В пакет Google Таблицы, если вы открываете
электронную таблицу и используете действие
Перейти к ячейке с параметром ячейки
Определенная ячейка, а электронная таблица
содержит более 40 000 строк, и вы выбираете
параметр На одну ячейку вниз, то бот теперь
выполняется успешно. Ранее при выполнении бот
возникала ошибка.

12342 00788970 Теперь имя бот правильно переводится на
китайский язык (упрощенное письмо) в окне Бот
выполняется. Ранее имя бот отображалось в окне
Бот выполняется в искаженном виде.

12342 01270344, 01767148 Теперь при использовании пакет Google Таблицы
и открытии электронной таблицы Google можно
использовать action Получить имена всех
листов, чтобы успешно получить имена всех
листов. Ранее, если в электронной таблице Google
было более пяти листов, в работе бот возникала
ошибка.

12342 01709026,
01755897,
01768689,
01761434, 01554474

При установлении соединения с помощью драйвера
OBDC в пакет База данных ошибка больше не
возникает. Теперь для Microsoft SQL Server в
таблицу базы данных для столбца int пустое
значение вставляется как 0.

12342 01602081 При использовании actions из пакет Веб-служба
REST для отправки запросов в API-интерфейс
REST и получения ответов из него, а также для
сохранения статуса ответа API-интерфейса в
переменной словаря, теперь REST возвращает
заголовки и пустое содержимое тела в ответе,
даже если API-интерфейс не имеет тела ответа.
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12342 01758733 Если вы выполняете миграцию с Enterprise 11
на Automation 360, после редактирования или
добавления некоторых actions в бот, который
отсутствует в родительском бот, сохранение бот
теперь выполняется без задержки. Ранее для
сохранения бот требовалось некоторое время.

12342 01254323 Больше не возникает ошибка при использовании
action Создать книгу из пакет Расширенный Excel
для создания рабочей книги внутри папки в пути к
сетевому диску.

12342 01036851 При открытии файла с расширением .xlsx
с использованием action Открыть из пакет
Расширенный Excel выполнение бот больше не
завершается сбоем, даже если промежуточная
родительская папка не имеет прав доступа.
Например, action Открыть может открыть файл из
папки \\\share\a\b\c\file.xlsx, если папка \
\\share\a\b\c имеет права доступа, даже если
папка \\\share\a или \\\share\a\b не имеет
прав доступа.

12342 00827204 На компьютерах, использующих японскую и
китайскую версии операционных систем, больше
не возникает ошибка, когда вы пытаетесь вернуть
вкладку на первую открытую веб-страницу с
использованием action Назад из пакет Браузер и
отменить выбор параметра Вызывает ошибку,
если количество шагов превышает историю.

12342 00777283, 00829912 Когда вы используете action Открыть из пакет
Расширенный Excel для открытия листа Microsoft
Excel, используете action Заменить из пакет
Расширенный Excel для замены строки в листе,
а затем запускаете бот, теперь бот выполняется
должным образом и не зависает, даже если
заменяемая строка в листе Excel отсутствует.

12342 00835312 Больше не возникает ошибка, когда вы создаете
ярлык папки с использованием action Открыть
программу/файл из пакет Приложение для
открытия файла, а затем используете action
Создать ярлык из пакет Папка.

12342 00757943,
00787404,
00788421,
00807528,
00822941, 01018972

Теперь можно использовать action AI Sense в
родительском бот и action Распознавание текста
(OCR) в дочернем бот или оба actions вместе для
успешного запуска бот. Ранее это приводило к
ошибке ABBYY FineReader Engine 12.
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12342 01212753, 01470071 Когда текущий сеанс приложения в Citrix
закрывается и приложение перезапускается,
теперь Средство записи идентифицирует объект
и успешно выполняет правильное action. Ранее
Средство записи не удавалось идентифицировать
объект.

12342 00742936, 00808117 Теперь можно преобразовать значение даты
и времени, указав пользовательские форматы
даты и времени (например, hh:mm:ss). Ранее
при использовании обозначения hh для указания
пользовательского формата времени возникала
ошибка.

12342 01266752 Если вы используете версию 6.2.0-20210903-141520
пакет Расширенный Excel для выполнения макроса
на листе Microsoft Excel, теперь значения в
связанных ячейках листа Excel обновляются
правильно.

12342 01755439 При использовании версии 2.5.3-20220304-010651
пакет Средство записи для создания снимка
объекта ошибка больше не возникает. Ранее,
когда использовался пакет Средство записи
версии 2.4.0-20211118-080716, возникал сбой
бот с указанным ниже сообщением об ошибке.
Не удалось выполнить бот из-за ошибки в
настройке среды выполнения

12342 01276429 Теперь после миграции можно вызывать
многократно используемый бот с новой версией
пакет из того же родительского бот, с которым
у него был общий сеанс. Это можно сделать,
вставив переменную сеанса, инициализированную
с использованием значения, в ключ в словаре с
помощью action Словарь > Вставить.

12342 00805417,
00815023, 01049408

Теперь можно использовать Средство записи для
успешного выполнения нажатий клавиш и создания
снимков объектов на новой вкладке, открытой в
браузере Google Chrome.

12342 -- Теперь в action Браузер > Открыть при выборе
предустановки Последняя использованная
вкладка браузера для окна Internet Explorer
в параметре Существующая вкладка
активируются соответствующая вкладка и окно.

12342 01755590 Теперь в Рабочая область RPA при переходе в
раздел Автоматизация > Bot Store и входе в
систему можно без проблем получить доступ к Bot
Store.
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12342 -- Когда вы добавляете или удаляете функцию
потребителя из ячейки, значения функций при
сортировке таблицы больше не изменяются. Ранее
значения в столбцах «Кем изменено» и «Последнее
изменение» непреднамеренно изменялись.

12342 01272058, 01752731 Теперь вы можете приостановить или остановить
автоматизации рабочих нагрузок в процессе
выполнения, и Внутренняя ошибка сервера
больше не возникает.
Ранее нельзя было приостановить или остановить
автоматизацию рабочей нагрузки после того, как
пользователь, создавший автоматизацию, был
удален из Control Room.

12342 01181402, 01260706 При запуске автоматизаций рабочих нагрузок вам
больше не придется приостанавливать и затем
возобновлять выполнение боты, находящихся
в очереди, которые «зависли» в состоянии В
процессе выполнения.

12342 00790086 Исправлен некорректный перевод на японский
язык описания расписания в полях ежедневной
и ежемесячной периодичности для параметра
Запускать несколько раз (Управление >
Расписания > Запланировать запуск бота).
Корректное описание на японском языке теперь
доступно на странице Запланировать запуск
бота.

12342 00852637 Когда вы редактируете расписание бот в
Control Room, теперь в столбце расписания
на странице Запланировано отображается
правильная дата расписания, а не предыдущий
день. Ранее, например, если выполнение бот
было запланировано на 01 октября 2021 года,
на странице Запланировано отображалась
неправильная дата расписания — 30 сентября
2021 года.

12342 00821057, 01188160 Если файл экспортируется после изменения имени
и пути к папке бот, имя бот теперь соответствует
новому имени. Ранее бот экспортировался с
прежним именем.

12342 01252294 Теперь можно успешно импортировать zip-файлы
в формате Zip64 из среды разработки в рабочую
среду.

12342 -- Теперь можно запускать несколько очередей без
задержек между очередями. Ранее при запуске
нескольких очередей иногда между очередями
возникала задержка от 5 до 15 минут.
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12342 00800831,
00815411,
00826054, 00826058

Теперь при использовании параметра Экспорт
отмеченных элементов в CSV данные
расписания в файле .csv сохраняются правильно.
Ранее при экспорте данных расписания в файл csv
со страницы Control Room Запланированные
действия данные файла сохранялись
неправильно. Например, тип расписания был
сохранен в файле csv как Несколько раз, а не
как Однократно.

12342 01754721,
01753460,
01767806,
01759361,
01763327,
01764201,
01767827, 1770574

Теперь при изменении региональных настроек
системы запланированные для еженедельного
выполнения боты запускаются по расписанию из
Control Room. Ранее при изменении региональных
настроек системы боты не запускались по
расписанию.

12342 00714546,
00759029, 01257992

Теперь Control Room может интегрировать
репозиторий Git, который отклоняет force push.
Ранее некоторые протоколы безопасности
отклоняли все обновления force push, делая
интеграцию с Git несовместимой без настройки
флага force push. Теперь можно изменить
конфигурацию передачи Git из Control Room, чтобы
отключить флаг force push.

В приведенной ниже таблице перечислены ограничения, выявленные в текущем выпуске.

Ограничения

(ID обращения к облачному сервису: 01765712) If a MetaBot Логика was using a DLL file that
used classes without namespaces, after migration, any TaskBot that uses the MetaBot Логика does
not work.
Обходное решение. Manually update the DLL file to include namespaces for classes.

Если в предыдущих выпусках вы создали сопоставление функций Active Directory, то
при обновлении до Automation 360 v.24 некоторые ранее определенные сопоставления
групп удаляются, так как столбец «Различающееся имя» (DN) в записях сопоставления в
базе данных содержит пустые строки без значений. Перед обновлением до Automation 360
v.24 запустите сценарий для заполнения столбца DN. (ID обращения к облачному сервису:
00751756)
Для получения поддержки по этому вопросу обратитесь в службу поддержки: Open a support
case (A-People login required)

В утилите предварительной миграции Bot Insight возникает ошибка и утилита закрывается,
если она обнаруживает поврежденные идентификаторы информационных панелей в
таблицах BI. (ID обращения к облачному сервису: 00796546)
Обходное решение. Загрузите и установите последнюю версию утилиты предварительной
миграции Bot Insight с сайта поддержки Automation Anywhere.
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Ограничения

Когда вы создаете боты с помощью перетаскивания actions из палитры «Действия», поток
операций бот смещается в правую сторону в представлении Поток.
Обходное решение.
• Когда вы создаете или редактируете бот в Bot editor, добавьте новые actions из палитры

«Действия», дважды щелкнув по action, которое вы хотите использовать.
Например, если вы редактируете бот и хотите добавить action после строки 7, установите
курсор после строки 7, а затем на палитре «Действия» дважды щелкните по action,
которое хотите использовать.

• Если вы хотите использовать возможность перетаскивания, щелкните по actions и
перемещайте их по холсту немного быстрее.

(ID обращения к облачному сервису: 01798098) При обновлении Automation 360 с
предыдущего выпуска до этого выпуска на компьютере Windows может появиться следующее
сообщение об ошибке, связанной с недействительной цифровой подписью:
Ошибка 1330. A file that is required cannot be installed because the
 cabinet file
        E:\AA\....\Data1.cab has an invalid digital signature.

Обходное решение. A360.24 Installation Failure "Error 1330 Invalid Digital Signature" (A-People
login required)

Если выбран параметр Автоматическое обновление всех бот-агентов и вы выполняете
обновление до этого выпуска, некоторые Bot Agent могут не обновиться до последней версии
автоматически.
Обходное решение.
1. Вручную удалите существующую версию Bot Agent.
2. Установите последнюю версию Bot Agent.

При выполнении миграции боты Enterprise 11 с помощью включенной команды Комментарий
эта команда отключается после миграции. (ID обращения к облачному сервису: 01255723,
01252824, 01260677, 01608653)

Когда после миграции вы выполняете вход как администратор, а затем начинаете миграцию
бот, на панели Журналы аудита периодически появляется сообщение об ошибке Сбой Bot
Launcher.

Когда вы выполняете миграцию боты с системными переменными (например датой,
месяцем или годом) в качестве параметра Экспорт данных в CSV, отображается ошибка
предварительной обработки. (ID обращения к облачному сервису: 01755175)

При обновлении Control Room с версии Automation 360 v.21 или v.22 до версии Automation 360
v.23 или v.24 может произойти сбой установки из-за проблем с миграцией расписаний. (ID
обращения к облачному сервису: 01376353, 01449535, 01713118, 01627144, 01762404)
Обходное решение. Open a support case (A-People login required).

Администраторы могут экспортировать данные (до 100 000 записей) в файл CSV. Загруженные
CSV-файлы аудита временно сохраняются в папке C:\Windows\TEMP\ среды On-Premises.
Файлы в этой папке с именами, начинающимися с cr-audit, не должны удаляться в течение
как минимум 90 дней и могут быть загружены из Control Room.
См. Export audit data to CSV
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Ограничения

При автоматическом обновлении Bot Agent одновременно на 500–1000 устройствах в Control
Room (On-Premises) происходит сбой.
Обходное решение. Вручную обновите Bot Agent на нескольких устройствах одновременно
со страницы Устройства Control Room.

Когда в таких браузерах, как Microsoft Edge (Chromium) и Mozilla Firefox, загружается файл
установщика Bot Agent, информация о загрузке отображается в правом верхнем углу, хотя
стрелка загрузки указывает на левый нижний угол панели задач браузера.
Стрелка загрузки указывает в правильном направлении только в браузере Google Chrome, в
котором информация о загрузке отображается в левом нижнем углу панели задач браузера.

Для установки Control Room в операционной системе Linux файл
AutomationAnywhereBotAgent.msi недоступен для загрузки с помощью параметра
Загрузить установщик на странице Control Room > Администрирование >
Настройки.
Обходное решение. Чтобы установить Bot Agent, используйте файл
AutomationAnywhereBotAgent.msi в папке <путь к файлу приложения>\crui\asset
в Control Room (On-Premises), установленной в операционной системе Windows. Подробнее
см. в разделе Sample steps to create Bot Agent golden image (A-People login required).

В пакет Эл. почта, когда вы используете параметр Дизайн HTML для создания и настройки
макета и тела письма, а затем вставляете содержимое, скопированное из другого источника,
такого как Outlook или Notepad++, в настоящее время для указанных ниже actions стиль,
размер и цвет шрифта не сохраняются.
• Отправить
• Ответить
• Переслать

При создании бот с помощью таких actions, как Отправить, Ответить или Переслать, в
Эл. почта пакет, выберите параметр на вкладках Обычный текст, Дизайн HTML или Код
HTML для форматирования текста сообщения. При переключении между этими вкладками
(Обычный текст, Дизайн HTML или Код HTML) ранее установленное значение в теле
сообщения не сохраняется, тело сообщения становится пустым.

• Вложенные элементы iFrame в браузерах Google Chrome и Microsoft Edge Chromium не
поддерживаются.

• Поддержка захвата всплывающих окон проверки подлинности недоступна при
автоматизации браузера Google Chrome.

• Если во время выполнения action к приложению или странице добавляется кадр, и
если в этом кадре появляются всплывающие окна, диалоговые окна предупреждений,
диалоговые окна подтверждения или диалоговые окна с запросами, то после выполнения
в приложении или на странице захват этих всплывающих окон и диалоговых окон не
выполняется.
Обходное решение. Используйте actions в пакет «Распознавание изображений» или
action Мышь > Щелчок, чтобы запустить бот.

На компьютерах, на которых в качестве значения параметра SystemLocale задан язык,
отличный от английского, если вы открываете несколько вкладок в браузере, пытаетесь
выполнить какое-либо action на новой вкладке, которая в данный момент неактивна, и
запускаете бота, неактивная новая вкладка не становится активированной.
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Ограничения

В Internet Explorer, чтобы активировать одну из нескольких веб-страниц без заголовков ,
сравниваются только полные имена доменов (FQDN). Если страницы без заголовков, но с
одинаковым именем FQDN открываются в Internet Explorer, активируется любая вкладка,
совпадающая с FQDN.

В Internet Explorer при использовании action Закрыть для вкладки или окна, закрытие
происходит, только если на вкладке или в окне нет диалогового окна предупреждения.

Прим.:  Вкладка или окно Internet Explorer с диалоговым окном предупреждения закрывается
только при закрытии диалогового окна предупреждения вручную.

При использовании action Открыть из пакет Расширенный Excel для открытия файлов с
расширением .xlsm, в которых есть диаграммы, происходит сбой бот и выдается ошибка.
Обходное решение. Укажите имя листа Excel в поле Имя определенного листа и затем
запустите бот. Если имеются скрытые листы, отмените скрытие определенного листа и
сделайте его активным.

Когда вы автоматизируете веб-приложения, работающие на Microsoft Edge Chromium с
режимом IE или Internet Explorer, то Средство записи иногда не удается выполнить захват
объекта на текущей выбранной вкладке браузера и вместо этого выполняется захват на
последней использованной вкладке.
Обходное решение. Обновите Bot editor, а затем снова начните запись.

When you use the Средство записи to capture an object, select HTML Tag, HTML InnerText,
and HTML type properties in Search Criteria, or migrate a бот with similar properties selected in
Search Criteria, the бот might fail to identify or locate the object and perform the selected action.
Обходное решение. Измените DomXpath в соответствии с элементами управления, для
которых выполняется захват, или добавьте дополнительные свойства в разделе Критерии
поиска.

When you use the Дата/время пакет released with Automation 360 v.23 or earlier to create a бот
that uses the Datetime Assign action, then select the variable option to add the variable value
and try to run the бот with package released with Automation 360 v.24 or later, the UI shows a
compilation error, and the user must select the variable value again.

In the Средство записи пакет, the Run in background option that enables an automation to run
in the background is not supported for applications running on Google Chrome, Microsoft Edge, and
Mozilla Firefox browsers for any of the Средство записи actions.

В приведенной ниже таблице перечислены ограничения из предыдущих выпусков, которые также
применимы к данному выпуску.

Ограничения из предыдущих выпусков

Когда вы выполняете миграцию бот, который использовал action Manage Window Controls,
последняя цифра значения высоты недоступна после миграции. Тем не менее, бот будет
выполнен успешно. (ID обращения к облачному сервису: 01756996)
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Ограничения из предыдущих выпусков

Когда сеанс Excel активен в SAP, соответствующий процесс Excel запускается в фоновом
режиме. В таком сценарии Automation 360 использует тот же процесс Excel, который запущен
в SAP. Когда вы запускаете бот для автоматизации данных электронной таблицы, Automation
360 успешно обрабатывает первый запрос. Но если Excel закрыт во время выполнения
и отправляется следующий запрос на автоматизацию данных электронной таблицы,
Automation 360 не обрабатывает запрос, поскольку к процессу Excel все еще обращается SAP.
Поэтому для автоматизации данных электронной таблицы не активируется нужное окно. (ID
обращения к облачному сервису: 00815159)

Если вы выполняете обновление напрямую с Automation 360 On-Premises v.21 до этого
выпуска, вы можете столкнуться с проблемами при обновлении вашего Bot Agent на
некоторых машинах Bot Runner в указанных ниже сценариях.
• После обновления Control Room состояние устройства продолжает меняться и Bot Agent не

может выполнить обновление автоматически.
• Если файл embedded resources отсутствует, то Средство записи не распознает

элементы пользовательского интерфейса или не захватывает ни один объект в браузере
Google Chrome.

Обходное решение. Перед обновлением до этого выпуска удалите указанные ниже файлы
и папки Bot Agent.
• C:\Windows\System32\config\systemprofile\AppData\Local

\AutomationAnywhere\AA-DB.mv.db
• C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-resources

Для получения дополнительной информации см. Bot agent auto update fails post the Control Room
Upgrade with 'device.connection.lost' (A-People login required) | The recorder is not able to recognize the
GUI elements in Google Chrome browser (A-People login required).

Когда вы используете команду Эмулятор терминала с действием Отправить текст, которая
содержит клавишу перевода строки (Enter), то может произойти сбой команды, если клавиша
перевода строки не поддерживается в Эмулятор терминала.
Обходное решение. Убедитесь, что вы заменили клавишу перевода строки
поддерживаемыми символами, такими как символ пробела.

После миграции пользователь может удалить файл .atmx, даже если файл связан с
расписанием Automation 360 Control Room.

При настройке внешнего хранилища ключей в разделе Интеграция внешнего хранилища
ключей и выборе режима Проверка подлинности SQL для аутентификации базы данных
на странице Сервер базы данных установщика Windows с целью установки Control Room
(On-Premises) происходит сбой установки и отображается указанное ниже сообщение об
ошибке. Сбой при создании таблиц базы данных Control Room.
Обходное решение. Добавьте учетные данные базы данных во внешнее хранилище ключей
и используйте их для настройки базы данных.

Недавно созданные пользователи Control Room в Windows для виртуальных машин Google
Cloud Platform On-Premises не могут изменить свой пароль. Параметр контрольных вопросов
недоступен на экране Изменить пароль, и в результате при попытке сохранить пароль
Control Room отображает ошибку.
Обходное решение. Обновите страницу и измените пароль еще раз.
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Ограничения из предыдущих выпусков

(ID обращения к облачному сервису: 01768545) Зависший статус обновления
IN_PROGRESS во время миграции с Enterprise 11 на Automation 360
Когда вы выполняете миграцию с Enterprise 11 на Automation 360, то даже в случае успешной
миграции бот Bot Insight не обновляет статус в Control Room. До версии 11.3.2 флаг
аналитики исторически был включен по умолчанию, поэтому все создаваемые боты
идентифицируются как аналитические боты. Некоторые боты, идентифицированные как
аналитические боты, не имеют обработанных данных, доступных на информационной панели
Bot Insight. В результате статус миграции зависает (IN_PROGRESS), даже если миграция бот
выполнена успешно.

Когда вы пытаетесь автоматизировать какой-либо процесс в приложении Java, использующем
версию AdoptOpenJDK 11.0.8, то Средство записи иногда не выполняет захват выпадающих
элементов в приложении.

Automation Anywhere Robotic Interface (AARI)

Новые возможности

Поддержка Microsoft Edge Chromium и Safari для AARI
Теперь можно создавать формы и процессы в Рабочая область RPA и запускать запросы,
задачи и боты в веб-интерфейсе в браузерах Microsoft Edge Chromium и Safari.

Требования к браузеру для доступа к Рабочая область RPA

Создание полей паролей и скрытие конфиденциальной информации (ID обращения
к облачному сервису: 00714159, 01063512)
Теперь в Рабочая область RPA можно создавать поля паролей с помощью элемента Пароль в
конструкторе форм. Можно использовать элемент Пароль в веб-интерфейсе для добавления
маскированного текста в поля пароля в исходных формах, чтобы скрыть конфиденциальную
информацию.

Настройка процессов | Свойства элемента «Пароль»

Настройка пользователя планировщика для каждой рабочей группы
Теперь можно получить доступ к странице Процесс в веб-интерфейсе, чтобы редактировать
процесс и назначить пользователя планировщика для каждой рабочей группы. Это
гарантирует, что боты в процессе развертываются на устройствах, назначенных рабочей
группе, и что эти устройства не используются другой группой. Пользователь планировщика
Группа установлен по умолчанию, но если пользователь планировщика не определен,
то выбирается пользователь планировщика Процесс. Пользователь планировщика
Глобальный будет выбран только в том случае, если не выбраны пользователи
планировщика Группа или Процесс.

Назначение пользователя планировщика процессу в веб-интерфейсе
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Новые возможности

Настройка типа развертывания планировщика (ID обращения к облачному сервису:
00814885, 01276257)
Теперь можно настроить тип развертывания планировщика для задач бот в рамках вашей
настройки процесса и определить, как будут развернуты боты в процессе. Можно определить
сопоставление между пользователем, от имени которого выполняется задача, и устройством,
что поможет справиться с ограничениями, такими как ограничения для учетных данных,
которые требуют взаимно однозначного сопоставления между пользователем, от имени
которого выполняется задача, и устройством.

Настройка типа развертывания для боты

Усовершенствование идентификатора ссылки для запросов
Теперь можно просмотреть идентификатор ссылки, связанный с вашим процессом, в столбце
Ссылка на странице Запросы. Идентификатор ссылки представляет собой комбинацию
префикса и номера, создаваемую на основе Ключа процесса, который можно ввести при
первом редактировании процесса. Этот идентификатор ссылки увеличивается каждый раз,
когда создается запрос от соответствующего процесса.

Свойства идентификатора ссылки | Configure an AARI process

Настройки хранения запросов
Теперь при редактировании процессов появилась возможность задать, когда выполненные
запросы будут перемещены со страницы Запросы в Корзину. С помощью этой функции
можно избежать необходимости ручного перемещения в Корзину каждого выполненного
запроса по отдельности. Настройки перемещения выполненных запросов в Корзину можно
отключить. Можно также задать количество дней, по истечении которых запросы будут
удаляться из Корзины.
Configure an AARI process

Рабочая группа по умолчанию, назначенная процессу
Теперь можно редактировать процесс, чтобы отобразить рабочую группу по умолчанию,
которой назначен процесс, в поле Группа по умолчанию. Первая рабочая группа, которой
назначается процесс, автоматически устанавливается в качестве группы по умолчанию. С
помощью этой функции можно просмотреть рабочую группу по умолчанию, которой назначен
процесс, не просматривая каждую отдельную группу.
Configure an AARI process

Просмотр статуса ботов в очереди
Теперь можно просматривать статус ваших боты, которые находятся в очереди и
не выполняются активно. Теперь на странице просмотра запросов рядом с вашими
поставленными в очередь боты, которые неактивны, отображается метка В очереди.

Статус «Отменено» для задач
Теперь можно фильтровать задачи по статусу Отменено на странице Задачи. Этот статус
будет отображаться в виде метки Отменено рядом с отфильтрованными результатами,
чтобы информировать вас о том, какие задачи были отменены пользователем. Выполнять
фильтрацию по этому статусу можно из выпадающего меню на панели состояния.

Фильтрация и поиск задач
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Новые возможности

Заполнение элементов исходных форм по параметрам URL-адресов
Теперь при создании запроса теперь можно заполнять элементы исходных форм, создавая
сценарии запросов, которые вводят определенные параметры в URL-адрес начальной формы.
Эти параметры применимы только для элементов Дата, Число, Текстовое поле и Время.

Параметры URL-адреса

Улучшение службы хранилища (ID обращения к облачному сервису: 00768394)
Как администратор арендатора, теперь вы можете задать параметр конфигурации
для блокировки загрузки исполняемых файлов, чтобы предотвратить нарушение
безопасности. Можно заблокировать загрузку файлов с указанными ниже
расширениями. .acm, .ax, .cpl, .dll, .drv, .efi, .exe, .mui, .ocx, .scr, .sys и .tsp.

Запуск виртуального окна в конфигурации бота
Если вы являетесь администратором AARI, вы можете настроить боты на странице Боты и
включить параметр Запустить бота в виртуальном окне. С помощью этого параметра
пользователь с сопровождением в AARI Assistant может запустить боты в виртуальном окне
без потери пользовательского опыта.
Configure an AARI bot

Добавление правил к элементу «Кнопка»
Теперь можно добавить правила к элементу Кнопка.

Использование элемента «Кнопка»

Настройка текста в формах с использованием обновлений элемента «Метка»
Теперь можно настраивать текст в формах различными способами, например, применять
полужирный шрифт, курсив, нижнее подчеркивание и другие эффекты форматирования,
изменять размер и цвет шрифта и так далее, используя элемент Метка. С помощью
этих параметров можно выделить определенные сообщения или тексты, такие как
следующие шаги, предупреждения или ошибки, когда они отображаются в исходной форме в
веб-интерфейсе.
Теперь элемент Метка предоставляет указанные ниже параметры форматирования.
• Выделение
• Цвет шрифта
• Размер шрифта
• Выравнивание текста

Использование элемента «Метка»

Поиск и фильтрация столбцов в таблице
Если на экране конструктора форм установить флажок Включить фильтрацию столбцов
для элемента Таблица, пользователи смогут выполнять поиск и фильтрацию содержимого
по всем доступным столбцам во время выполнения бот.
Теперь при использовании элемента Таблица для отображения таблицы в исходных формах
у вас есть расширенная возможность поиска каждого столбца таблицы по значению.

Использование элемента «Таблица»
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Новые возможности

Дополнительные параметры для правил
Благодаря дополнительным параметрам, включенным для правил в конструкторе форм,
теперь можно выполнять указанные ниже действия.
• Поиск правила с использованием строки поиска. В строке поиска введите имя правила или

метку элемента, связанную с каким-либо условием или action в правиле.
• Создание копии правила с помощью параметра Дублировать правило.
• Для нескольких правил можно использовать указанные ниже параметры, чтобы изменить

порядок выполнения этих правил во время выполнения бот.
• Переместить вверх
• Переместить вниз
• На самый верх
• В самый низ

Добавление правил к элементам формы

Применение action к нескольким элементам
При добавлении или редактировании правила, когда вы добавляете action, теперь можно
применить action к нескольким элементам, выбрав несколько элементов в меню Тогда.

Дополнительные условия «Если» для некоторых элементов
Теперь при создании или редактировании правила можно выбрать дополнительные условия
Если для указанных ниже элементов.
• Выпадающее меню
• Флажок
• Переключатель
• Дата
• Время
• Гиперссылка

Использование присвоения для обновления значения элемента выпадающего
меню
При добавлении правила, если выбрать элемент Выпадающее меню в качестве элемента
action в меню Тогда, теперь можно использовать выпадающее меню Присвоить для
добавления или замены значений во время выполнения бот.

Добавление правил к элементам формы

Элементы в условии «Если» теперь доступны в действии «Тогда»
Теперь все элементы, которые используются в составе условия Если, доступны в составе
действия Тогда.

Поддержка нескольких строк для области текста и редактора Rich Text
Теперь для элементов Область текста и Редактор Rich Text в рамках параметров Если и
Тогда поддерживается текст в несколько строк.

Добавление правил к элементам формы
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Изменения

Улучшения в импорте процессов в общедоступную папку
Теперь при импорте процесса в общедоступную папку процесс автоматически публикуется в
AARI. Ранее требовалось загружать импортируемые процессы в личный репозиторий, а затем
снова загружать процесс для его публикации в AARI.

Импорт процесса AARI | Импорт зависимостей процесса

Обновлен макет страницы процесса
Теперь макет страницы Процесс обновлен и согласован со страницами Бот и Группа.
Изменения затронули столбцы для идентификатора ссылки, ключа, названия, описания,
тегов и групп. Теперь на этой странице можно фильтровать результаты в строке поиска
для ускорения сортировки и быстро ссылаться на текущего пользователя глобального
планировщика.

Статус активного бота
Теперь на странице просмотра запросов можно просмотреть точный статус ваших ботов,
обратившись к метке В процессе выполнения рядом с активными боты, которые
выполняются в данный момент. Ранее метка В процессе выполнения показывала как
активных боты, так и поставленных в очередь боты, которые не выполнялись.

Ссылка на смену идентификатора запроса в AARI on the web
• Теперь можно фильтровать или инициировать запросы на вкладках Запросы и

Корзина и задачи на вкладке Задачи (Табличное представление и Подробное
представление) с помощью новой Ссылки вместо ID запроса.

• URL-адрес на страницах Запросы, Группа, Процесс и Боты теперь изменен на entity/
ref/:ref (вместо entity/:id). Если вы открываете любой запрос, используя ID
запроса, URL-адрес теперь перенаправляется с использованием Ссылки. Например,
рассмотрим ID запроса 896 и Ссылку 2-34 для запроса. Если вы просматриваете запрос,
используя ID запроса (/aari/#/requests/all#/requests/896), URL-адрес будет
перенаправлен с использованием Ссылки (/aari/#/requests/all#/requests/
ref/2-34).

Ссылка — это уникальный ключ, который поможет вам идентифицировать связанные
процессы и запросы на страницах Запросы, Группа, Процесс и Бот. Ссылка проще в
использовании и более значима, чем идентификатор запроса, поскольку она обеспечивает
логическую последовательность ссылочных номеров, увеличивающуюся с каждым клиентом.
Ссылка уникальна в рамках клиента, но может быть одинаковой для двух клиентов.

Свойства идентификатора ссылки

В приведенной ниже таблице перечислены исправления, а также сборка, в которой была
исправлена каждая проблема. Сборка 12350 является последней сборкой и включает в себя
исправления из предыдущих сборок.

Исправления

Сборка ID обращения к
облачному сервису

Описание

12350 01788376 You can now launch AARI using the Bot Agent (version
21.133) connection without errors.
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Исправления

Сборка ID обращения к
облачному сервису

Описание

12350 01803979 Если вы настроили Control Room с помощью SAML
и щелкаете по значку AARI на рабочем столе
Windows, теперь вы будете перенаправлены
на веб-страницу AARI Assistant вместо главной
страницы Control Room.

12342 01759135 Когда вы используете элемент Дата и выбираете
параметр Использовать дату локальной
системы после загрузки формы, то дата
теперь отображается правильно, то есть как дата
локальной системы.

12342 01766579 Если вы — Bot Creator, после создания запроса с
использованием вашего AARI теперь вы можете
отправлять исходную форму и выполнять задачи,
не «зависая» на странице просмотра запроса

12342 -- Для Рабочая область RPA с настройкой SDS при
вводе данных или загрузке файлов в исходных
формах после выбора процесса для выполнения
запроса больше не появляется сообщение об
ошибке исключения.

12342 -- Когда вы используете элемент Флажок для
создания CheckBoxGroup в вашей форме
и устанавливаете правила форм и условия
для каждого поля в этой группе (C1, C2, C3
и т. д.), теперь выделения в исходной форме
функционируют правильно, как определено
вашими правилами формы.

12342 -- Если вы являетесь менеджером Bot Creator и AARI,
вы больше не сталкиваетесь с ошибкой при запуске
бота с использованием действия Участники
группы из пакета AARI Web для доступа к
рабочим группам.

12342 -- Если вы являетесь участником группы по функции
(то есть, если вы были впервые добавлены в
функцию в Control Room и эта функция после
этого была синхронизирована с рабочей группой),
теперь вы сможете просматривать обновленную
информацию для своих запросов и задач. Теперь
последние данные о запросе и задаче на странице
обновляются автоматически.

12342 -- В веб-интерфейсе, когда в представлении
запроса задачи завершены и вы подтверждаете
их нажатием кнопки Готово, Отменить или
другим основным или второстепенным способом,
теперь эти типы событий фиксируются в истории
Журнала аудита Рабочая область RPA как тип
события «Задача, выполняемая человеком» AARI.
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Исправления

Сборка ID обращения к
облачному сервису

Описание

12342 -- Теперь в среде Linux можно использовать
функцию загрузки файлов AARI on the web без
каких-либо проблем. Ранее функция загрузки
файлов не работала с ошибкой «доступ запрещен»,
потому что каталог filestorage не создавался
автоматически для хранения файлов.

12342 -- Кнопка Редактировать больше не включается
для процессов, которые загружены, выгружены или
клонированы. Ранее можно было редактировать
имена процессов, которые были загружены,
выгружены или клонированы, хотя изменения не
сохранялись.

12342 -- Для любого элемента в форме, если вы
используете параметр Сделать поле
недоступным для редактирования в
конструкторе форм или отключаете его при запуске
связанного бот, валидации форм, применяемые к
этому элементу, аннулируются.

Ограничения

В некоторых сценариях при запуске бот, настроенного на запуск в виртуальном окне,
запускается виртуальное окно и появляется запрос на выполнение входа с учетными
данными.
Обходное решение. Перезагрузите систему и запустите бот снова.

При разработке формы можно создать ссылки для скрытых элементов, используя параметр
Скрытые элементы из свойств формы. Однако после завершения разработки формы
невозможно будет просматривать или изменять переменные в скрытых элементах.

После завершения разработки формы с назначенным ей правилом выпадающего меню,
если вы просматриваете выпадающее меню в режиме только для чтения, невозможно будет
просмотреть измененные данные в режиме только для чтения.

Если в форме имеется элемент Выбрать файл, невозможно загрузить файл, в имени
которого содержатся специальные символы (например: , ( ) & ; - =), при запуске бот.

В веб-интерфейсе, когда вы находитесь на странице, отличной от главной, и сеанс входа в
систему прекращается и снова возвращает вас на страницу входа в систему, параметр next=
отображается в URL-адресе неограниченно долго. Это может стать проблемой, поскольку
параметр next= используется для перенаправления URL-адреса на предыдущую страницу, но
в настоящее время этот параметр не поддерживается.

Для элемента Текстовое поле правило формы Не содержит не работает.

Для элемента Редактор Rich Text правило формы Содержит не работает.

Для элемента Таблица параметр Строки перед прокруткой может поддерживать
только до четырех строк. Если вы указываете пять или более строк, этот параметр не
поддерживается и вместо него необходимо выполнить прокрутку.
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Ограничения

При создании формы с помощью элементов Документ и Выпадающее меню и попытке
отправить эту форму возникает ошибка. Эта ошибка связана с динамической схемой формы,
например выпадающим полем, заполненным процессом, который присутствует в форме с
полем документа и вызывает ошибку.

Discovery Bot

Новые возможности

Сохранение записи с именем
После записи процесса можно сохранить запись с именем. Имя записи отображается на
странице Записи для этого процесса.

Запись бизнес-процесса Discovery Bot

Предоставление общего доступа к описанию записи
Теперь можно предоставить описание для записи процесса, используя страницу Записи для
этого процесса. На странице Записи воспользуйтесь полем Описание, чтобы предоставить
аналитику доступ к контексту и цели записи. Представленное описание отображается также в
PDD.

Запись бизнес-процесса Discovery Bot

Удаление записи
После записи процесса, если вы не хотите отправлять данные записи аналитику для
просмотра, вы можете удалить эту запись, используя страницу Записи для этого процесса.
Чтобы удалить запись, воспользуйтесь параметром Удалить на странице Записи.

Запись бизнес-процесса Discovery Bot

Запись бизнес-процессов с использованием AARI Assistant
Теперь для записи бизнес-процессов без входа в Control Room можно использовать AARI
Assistant. Чтобы записать бизнес-процесс, запустите AARI Assistant двойным щелчком по AARI
на рабочем столе.

Запись процесса Discovery Bot с использованием AARI Assistant

Расширение пользовательских возможностей
Теперь можно обновить потенциальные затраты и экономию для пользовательских
возможностей и сохранить изменения на диаграмме процесса. Потенциальные затраты
и потенциальная экономия могут быть обновлены в любое время по мере того, как вы
просматриваете шаги из различных записей и вносите изменения в диаграмму процесса.

Анализ возможностей, преобразование в бот и создание PDD

Улучшение PDD
Теперь можно просмотреть всю диаграмму процесса изнутри Discovery Bot, щелкнув по
ссылке на URL-адрес, предоставленной в PDD. Если выбрано более 100 шагов, диаграмма
процесса в PDD не отображается.

Анализ возможностей, преобразование в бот и создание PDD
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Изменения

В документе обнаружения процесса (PDD) теперь отображаются китайские символы Unicode,
как в формате Word, так и в PDF.

Исправления

ID обращения к
облачному сервису

Описание

-- Пользователи облака. Теперь при записи более 250 шагов
можно создать настраиваемую возможность для автоматизации и
сгенерировать PDD.

-- Теперь загрузить PDD для пользовательских возможностей и
записей можно без каких-либо проблем. Ранее периодически
возникала ошибка и отображалось указанное ниже сообщение об
ошибке. Ошибка при создании PDD

-- Теперь сообщение об ошибке отображается, когда вы не можете
подключиться к Control Room. Например, это происходит,
когда для настройки Control Room для развертываний On-
Premises используется самоподписанный сертификат или
сертификат с поддержкой поддоменов, а этот сертификат не был
установлен заранее. Страница Процессы не загружается. Чтобы
подключиться к Control Room, следуйте инструкциям в сообщении.

00829246 Пользователи Cloud. Теперь можно загрузить PDD для
возможности автоматизации с 200 или более шагами. Раньше при
создании возможности с 200 или более шагами щелчок по кнопке
Загрузить PDD приводил к возврату ошибки.

-- Теперь таблица Записи работает должным образом для
автоматически генерируемых и пользовательских возможностей.
Ранее при этом периодически возникала ошибка.

00827381 Теперь при поиске пакета Средство записи в японском
пользовательском интерфейсе можно просмотреть правильное имя
пакета для Средство записи.

В приведенной ниже таблице перечислены ограничения, выявленные в текущем выпуске.

Ограничения

В редких ситуациях, когда процессор устройства занят, снимок экрана записи может не
получиться со страницы Записи для процесса. Однако действия пользователя, такие как
выделение текста, на странице Записи отображаются.

В приведенной ниже таблице перечислены ограничения из предыдущих выпусков, которые также
применимы к данному выпуску.
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Ограничения из предыдущих выпусков

Когда вы добавляете ветви с левой и правой стороны от основной ветви, раздел PDD «Запись
блок-схемы» может не захватить весь поток операций процесса, включая все ветви.

Feature deprecation for Discovery Bot

Review the deprecated feature to understand how it can impact your automation.

Discovery Bot red highlight
In the recording session, the red outline that highlights when you move the mouse over the area
to capture the action has been deprecated as of June 2021. The red outline is displayed in the
screenshot images when you review your captured steps from the Recordings page.

IQ Bot

Новые возможности

Document Automation — выпуск с ограниченной доступностью
Теперь определенная группа первых пользователей может использовать Document
Automation для автоматизации обработки бизнес-документов в новом облачном и
интеллектуальном решении для обработки документов от Automation Anywhere.
Решение Document Automation интегрировано в Control Room. Когда вы создаете обучаемый
экземпляр, IQ Bot автоматически создает боты RPA для извлечения и загрузки данных и
процесс AARI для управления всем процессом. Обучаемые экземпляры не требуют обучения.
Вместо этого Document Automation для обработки счетов-фактур и квитанций использует
предварительно обученные модели.
Document Automation | Intelligent Document Processing solutions feature comparison matrix

Общее количество страниц, загруженных для действия «Обработка документов»
В Automation 360 IQ Bot, когда вы используете action Обработка документов из пакет
IQ Bot Extraction для обработки документов, теперь можно просмотреть общее количество
загруженных страниц, отображаемое в разделе Информационные панели > Мое общее
количество

Использование action IQ Bot Обработка документов

Доступно ролевое управление доступом (РУД)
Теперь Automation 360 IQ Bot обеспечивает ролевое управление доступом (РУД). Можно
использовать РУД для обработки разрешений, позволяющих пользователям выполнять
указанные ниже действия.
• Edit learning instance
• Delete learning instance
• Send learning instance to production
• Импортировать домен

Определение пользовательской функции для IQ Bot
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Новые возможности

Ротация ключей шифрования как AAE_Администратор IQ Bot
Благодаря функции AAE_Администратор IQ Bot вы теперь можете изменить ключ
шифрования путем изменения имени объекта на новой странице Администрирование >
Ротация ключей.

Ротация внешних ключей

Новая модель для Cognitive MLWeb Service
Теперь в On-Premises установках Automation 360 IQ Bot можно добиться улучшенного
обнаружения флажков и таблиц при использовании новой модели Cognitive MLWeb Service.

Изменения

Теперь для локальных установок IQ Bot служба MLScheduler Service в окне служб Microsoft
Windows по умолчанию отключена, чтобы освободить системные ресурсы.

Исправления

ID обращения к
облачному сервису

Описание

00764550, 00765854 При миграции с Enterprise 11 на Automation 360 любой обучаемый
экземпляр с пользовательским доменом, имеющий поля на
китайском языке, теперь отображается правильно. Ранее эти поля
заполнялись неверными значениями вместо китайских символов.

00758208, 00632965,
00727063, 00715124,
00828988, 01251514

Служба MLScheduler в On-Premises IQ Bot теперь отключена
, и система больше не замедляет свою работу и не перестает
отвечать. Ранее функции автокоррекции и автоподсказки,
которые являются частью сервиса MLSchedulr, использовали
значительные системные ресурсы и вызывали замедление или
остановку работы системы.

01757917 Теперь документы успешно классифицируются с помощью
функции распознавания текста (OCR) Microsoft Azure 3.2. Ранее
из-за устаревания OCR с предпросмотром Microsoft Azure v3.2-
preview.2 документы оставались неклассифицированными.

-- Документы, извлеченные с помощью команды Auto Extract, теперь
обрабатываются успешно. Ранее, когда документы извлекались с
помощью команды Auto Extract, к ним не применялись валидации
из группы валидаций по умолчанию.

01261531 Когда вы создаете обучаемый экземпляр и используете
команду загрузки IQ Bot, теперь отображение стабильно без
каких-либо проблем. Ранее это приводило к изменению размера и
переключению между шрифтами большего и меньшего размера,
что вызывало мерцание экрана.

-- Чтобы вручную создать группу, теперь требуется только функция
IQBot_admin. Раньше для этого были необходимы функции
aae_basic и IQBot_admin.
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Исправления

ID обращения к
облачному сервису

Описание

-- В интерфейсе IQ Bot для групп, созданных вручную, теперь можно
увидеть Метку группы целиком. Ранее отображалась только
часть Метки группы.

-- Документы, имена файлов которых начинаются со специального
символа, например дефиса (-), теперь классифицируются и
обрабатываются должным образом. Ранее такие документы
задерживались в очереди на классификацию или оставались
необработанными.

01063054 Теперь можно импортировать обучаемый экземпляр с длинным
именем (более 50 символов) без каких-либо ошибок, потому что
параметр Метка сейчас поддерживает более 50 символов.

-- В случае обучаемого экземпляра стандартных форм, если вы
загружаете документ, содержащий таблицу с пустой ячейкой,
этот документ теперь отправляется в Валидатор IQ Bot. Ранее
документы с пустыми ячейками таблицы отправлялись в папку
Неудачно.

-- Ошибка больше не возникает при запуске бот, который содержит
actions из IQ Bot Pre-processor, IQ Bot Classifier и пакеты
Распознавание текста (OCR). Ранее в таких случаях возникала
ошибка Assertion failed.

01777853 Теперь вы можете создавать обучаемые экземпляры для
стандартных форм с помощью предварительно обученных
моделей с длинными именами полей (до 250 символов). Ранее
предварительно обученные модели, содержащие длинные имена
полей, вызывали ошибку.

Ограничения

При загрузке векторных PDF-документов в новый обучаемый экземпляр несколько документов
определяются как неклассифицированные. Если же преобразовать документы из PDF в TIFF и
загрузить их, эти документы будут успешно обработаны.

Если IQ Bot запускается с использованием учетных данных службы, а пароль содержит
пробел, то журналы IQ Bot не будут обновляться.

В некоторых случаях, даже если правильные число или сумма отражаются точно, некоторые
документы все равно не соответствуют правилу проверки из-за ошибки округления и
отправляются на ручную проверку.

Если в формулах используются такие разделители, как запятые или точки в качестве
разделителей тысяч, проверка формулы не работает.
Обходное решение
• Для английского языка. Удалите все разделители, такие как запятые, используемые в

качестве разделителей тысяч.
• Для других европейских языков. Удалите все разделители, такие как точки,

используемые в качестве разделителей тысяч. Для валидаций формул используйте
английские правила нумерации.
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Ограничения

Если вы используете ABBYY FineReader Engine версии 12.4 вместо версии 12.2, функция MICR
не поддерживает извлечение данных из документов на японском языке.

После резервного копирования баз данных и запуска инструмента «Помощник по миграции
баз данных» этот инструмент и журналы указывают на то, что миграция успешно завершена,
даже если унифицированная база данных не создана.
Обходное решение. Убедитесь, что установлены обе версии x86 и x64 пакета Microsoft
Visual C++ 2015-2019 Redistributable Package.

Bot Insight

Изменения

Данные startDateTime теперь имею стандартный формат
При экспорте данных в Microsoft Excel формат даты будет экспортирован в соответствии с
форматом даты виджета.

Исправления

ID обращения к
облачному сервису

Описание

-- Теперь, когда вы используете прокси-сеть, при щелчке по опции
Анализировать информационная панель сети генерирует анализ.
Ранее эта информационная панель не генерировала анализ.

-- Теперь при запуске бот, который был загружен в общую папку,
а затем выгружен в личную папку, дата последнего обновления
отображается точно. Ранее дата последнего обновления
отображалась как недействительная.

01252869, 01259449 Теперь деловая информационная панель доступна для
пользователей, которым назначена роль администратора BI и
пользовательская лицензия BI. Ранее пользователи с этой ролью
и лицензией не могли получить доступ к этой информационной
панели.

Ограничения

Невозможно детализировать данные, используемые при группировке по
продолжительности
Когда для параметра Группировать по в виджете выбрано значение продолжительность
(время/дата), детализация возможна только для одного уровня. При попытке детализации
данных на втором уровне или далее вы можете столкнуться с указанной ниже ошибкой.
Данные не найдены.
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Ограничения

(ID обращения к облачному сервису: 00777595) При попытке обновить данные на листе
Microsoft Excel может возникнуть ошибка аутентификации в результате нескольких
одновременных попыток использования открытых окон и вкладок.
Обходное решение
1. В настольном приложении Power BI перейдите в раздел Файл > Параметры и

настройки > Параметры.
2. В разделе Текущий файл выберите Загрузка данных.

Прим.:  Не выбирайте Загрузка данных в разделе «Глобальный»!

3. Снимите флажок Включить параллельную загрузку таблиц.

Заметки о выпуске Automation 360 v.23
Дата выпуска: 30 декабря 2021 года
Оцените новые возможности, изменения, а также исправления и ограничения в выпуске Automation
360 v.23 (Сборка 11513). Сборка 11513 заменяет сборки 11499 и 11486.

Важное замечание:
• Эта сборка включает в себя библиотеку Apache Log4j2 версии 2.17.1, в которой устранены

уязвимости CVE-2021-44832, CVE-2021-45105, CVE-2021-44228 и CVE-2021-45046.
Несмотря на то что пакеты команд не обновлены до версии 2.17.1 библиотеки Apache Log4j2, Bot
Agent обновлен до версии 2.17.1 библиотеки Apache Log4j2. Во время выполнения пакеты будут
использовать библиотеку Apache Log4j2 версии 2.17.1 через Bot Agent и, следовательно, не будут
подвержены уязвимости. В качестве дополнительной меры безопасности установщик Bot Agent
Automation 360 v.23 также отключает функцию поиска библиотеки Apache Log4j2 по умолчанию.
Сканеры безопасности сторонних производителей могут обнаружить следы более ранних версий
библиотеки Apache Log4j2. Однако после обновления до Automation 360 v.23 и принятия мер
по снижению рисков подверженность уязвимостям будет устранена. Подробнее см. в разделе
FAQs related to Automation Anywhere Releases regarding zero-day vulnerabilities (CVE-2021-44228,
CVE-2021-45046) (A-People login required).

• Эта сборка также включает в себя исправления для указанных ниже проблем.
• При обновлении с Automation 360 v.22 до v.23 фоновые задания, связанные с синхронизацией

облачного сервера лицензий, удалялись из-за неправильного имени задания лицензии.
• При установке или обновлении до Automation 360 v.23 для развертывания On-Premises файлы

журналов для некоторых дополнительных служб не обновлялись.
• Если у вас не было разрешения на выполнение действия Просмотреть пакет, развертывание

бот не удавалось, когда вы планировали или запускали бот.

• Миграция
11.x и 10.x | Только 11.x
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• Рабочая область RPA

Новые возможности | Изменения | Исправления | Исправления в системе безопасности |
Ограничения

• AARI

Новые возможности |  Изменения | Исправления | Ограничения
• Discovery Bot

What's new | Fixes | Limitations | Feature Deprecation
• IQ Bot

Новые возможности |  Изменения | Исправления | Ограничения
• Bot Insight

Изменения | Исправления | Ограничения

Обновление до этого выпуска

Обновленная Сборка 11513 для Automation 360 v.23 включает в себя библиотеку Log4j2
версии 2.17.1 и исправления. Если вы используете предыдущую сборку 11499 версии v.23 (с
библиотекой Log4j2 версии 2.17.0) или сборку 11486 (с библиотекой Log4j2 версии 2.16.0),
выполните обновление до Сборка 11513 для использования обновленной версии библиотеки Log4j2
и внесения исправлений.
Можно также выполнить обновление до Automation 360 v.23 с трех предыдущих выпусков (то есть
с выпусков n−3, где n означает последний выпуск). Перечисленные ниже предыдущие выпуски
сертифицированы для обновления до этого выпуска:
• v.22 (сборка 10526)
• v.21 (сборки 9664, 9642, 9595)
• v.20 (сборка 8815)

Вы можете напрямую выполнить обновление любой из этих сборок (см. Обновление до последней
версии Automation 360) до v.23. Если вы не используете выпуск n−3, перед обновлением до данного
выпуска обновите Automation 360 до одного из трех сертифицированных выпусков (перечисленных
выше).
Если вы выполняете обновление непосредственно до этого выпуска с Automation 360On-
Premises v.20 или v.21, удалите указанные ниже файлы и папки Bot Agent.
• C:\Windows\System32\config\systemprofile\AppData\Local\AutomationAnywhere

\AA-DB.mv.db
• C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-resources

Важное замечание:  Для использования новых функций в v.23 (включая обновления до пакетов
Средство записи) и для устранения уязвимости Log4j2 обновите Bot Agent для этого выпуска.
Обратите внимание, что обновление Bot Agent с предыдущего выпуска не требуется, если вы хотите
запускать существующие боты как Bot Runner.

Информацию об обновлении до этого выпуска см. на указанных ниже ресурсах.
• Автоматическое обновление Bot Agent | Обновление Bot Agent вручную
• Compatibility with release builds

Для получения информации о последних обновлениях до расширений Automation 360 для Google
Chrome, Microsoft Edge и Mozilla Firefox см. раздел Browser extensions for Automation 360.
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Особенности миграции

Особенности Enterprise 11 и Enterprise 10

MetaBots, содержащие связанные объекты
Миграция MetaBots, которые содержат связанный объект типа воспроизведения текста,
связанный с объектом режима воспроизведения объекта, связанный объект типа
воспроизведения изображения, связанный с объектом типа воспроизведения изображения,
и связанный объект типа воспроизведения координат, связанный с объектом типа
воспроизведения координат.

Миграция боты с указанными ниже атрибутами.
• Боты с переменными, содержащими данные размером более 64 КБ (ID обращения к

облачному сервису: 00716311,00756449,00819149)
В процессе миграции данные сохраняются в текстовом файле. Текстовый файл
загружается в Cloud Control Room и используется в бот после миграции.

• MetaBots с DLL, которые возвращают значения типа «список» и «массив» с любой
комбинацией разделителей и сохраняют эти значения в буфере обмена

• Теперь MetaBots можно мигрировать с помощью режима воспроизведения
изображений, в котором используется действие GetVisibility

• Теперь боты можно мигрировать с помощью действий GetSelectedIndex и
GetSelectedText для технологии автоматизации пользовательского интерфейса,
используемой в команде Клонирование объектов и на экранах MetaBot.

• Теперь можно мигрировать боты, которые автоматизируют приложения с помощью
технологии Java Тип, используя команду Клонирование объектов с действием
GetDataofAllchildren.

Боты с различным регистром символов переменных
Если мигрировать бот, который передал переменную из TaskBot в логику MetaBot или из
логики MetaBot в TaskBot, и если регистр символов имени переменной изменен в логике
MetaBot, в процессе миграции обновляется имя переменной с тем же регистром символов, что
и в бот, соответствующем перенесенной логике MetaBot в родительском TaskBot.

Миграция боты с изображением указателя (ID обращения к облачному сервису:
00754508, 00776192)
Теперь вы можете перенести боты, содержащие изображения, которые были получены с
помощью команды Object Cloning.

MetaBots, доступные в качестве зависимостей, не загружаются
В процессе миграции не загружаются MetaBots, которые доступны в качестве зависимостей.
Это ограничение введено для того, чтобы избежать загрузки MetaBots и создания нескольких
копий одних и тех же MetaBots, поскольку они уже доступны в репозитории Control Room.

Новое action в пакете автоматизации предыдущих версий для миграции (ID
обращения к облачному сервису: 00797140, 00849161)
Используйте action Замедлить нажатие клавиш, чтобы сопоставить длительность
задержки, определенной в боты Enterprise 11 для команды Вставить клавишу и
смоделировать то же значение в Automation 360 для action Имитация нажатия клавиш.
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Особенности Enterprise 11 и Enterprise 10

Уведомление о боты с проблемами в отчете Bot Scanner
В отчете Bot Scanner теперь отмечаются проблемные боты Enterprise 11 или Enterprise 10,
требующие действий или проверки. Например, боты с проблемами безопасности или боты,
которые ссылаются на несуществующие переменные, помечаются значком в сообщении о
действии или проверке.

Улучшенная проверка перенесенных боты
• Теперь для валидации бот во время выполнения доступны дополнительные валидации

времени компиляции. Например, если родительский бот вызывает дочерний бот, а
дочерний бот содержит ошибки компиляции, эти ошибки отображаются при попытке
выполнить родительский бот. Этим гарантируется, что ошибка не возникнет в середине
автоматизации и не сделает ее незавершенной.
Эта функция позволяет проактивно идентифицировать все перенесенные боты, которые
содержат ошибки компиляции. Перенесенные боты с ошибками компиляции отображаются
в разделе Успешно с просмотром в Отчете о миграции, Этим гарантируется то, что
вы можете получить список боты, которые требуют вашего внимания.
Чтобы включить функцию валидации бот, перейдите в раздел Администрирование
> Настройки > Боты > Валидация ботов и установите значение Вкл. См. раздел
Настройки.

• Теперь в Bot Migration Wizard отображается подробная информация об ошибках валидации
для каждого бот в результатах миграции бот. Подробная информация об ошибках
помогает проверить боты и принять меры в отношении перенесенных ботов, тем самым
сэкономив время.

Миграция корпоративных боты

Улучшенный помощник по миграции бот
Помощник по миграции теперь объединен с помощником по поиску ошибок, что обеспечивает
комплексное представление всех строк в бот, которые требуют проверки или действий с
вашей стороны, или в которых содержатся ошибки, и поэтому требуется их устранение. Эта
функция поможет вам быстро определить области боты, которые требуют вашего внимания.

Поддержка 32-разрядного драйвера для подключения к базе данных (ID обращения
к облачному сервису: 00757466)
Чтобы включить миграцию боты Enterprise 11 с помощью VBScript, теперь в Automation 360
поддерживаются 32-разрядные драйверы для подключения к базе данных.

© 2023 Automation Anywhere. All rights reserved.     317



    Automation Anywhere - Learn

Только для Enterprise 11

Миграция боты с указанными ниже атрибутами.
• Боты, которые содержат изображения, захваченные с помощью команды Object Cloning,

команды OCR > Захватить область, команды Интеграция приложений > Захватить
область и действия Щелчок мыши.

• Боты с HTML-телом сообщения электронной почты с локальными ссылками на
изображения, если эти изображения доступны на компьютере Bot Runner (ID обращения к
облачному сервису: 00780065, 00790657, 00827527, 00822092, 00928116, 01181845)

• Боты с командами Microsoft Excel с расширениями файлов, такими как .ods, .htm, .html,
.mht, .mhtml, .slk и .pdf, чтобы открывать файлы Excel (ID обращения к облачному
сервису: 00799071)

• MetaBots, которые используют переменную учетных данных нестрокового типа для
передачи числового значения в качестве входных данных функции DLL

Рабочая область RPA

Новые возможности

Расширенные возможности администратораТеперь администраторы Automation
Anywhere Control Room, имеющие соответствующие лицензии, могут создавать
действительных пользователей RPA на основе аутентификации с использованием имени
пользователя и пароля и выбирать вариант «не требовать аутентификации в реальном
времени с помощью ответа по электронной почте». Эта функция позволяет администраторам
повторно отправлять приветственные сообщения электронной почты для аутентификации без
необходимости сбрасывать учетные данные, назначенные пользователям RPA.

Microsoft Edge (Chromium) поддерживается для Control Room и Bot Agent
Теперь вы можете выполнять операции с Control Room, а также устанавливать и
регистрировать ваше устройство Bot Agent с помощью Microsoft Edge на основе Chromium.

Требования к браузеру для доступа к Рабочая область RPA

Поддержка Azure Key Vault
Automation 360 теперь поддерживает Azure Key Vault, и теперь из внешнего хранилища
ключей можно получить указанные ниже данные.
• Active Directory (AD), учетную запись службы и учетные данные SMTP
• Учетные данные для автоматического входа в систему
• Учетные данные нескольких видов автоматизации

Валидация Бот
Валидация Бот выполняется для новых боты и при запуске бот. Теперь администраторы
Control Room могут включать и выключать функцию валидации Бот. По умолчанию для
каждого Control Room эта функция отключена.

Миграция корпоративных боты
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Переменная Credential Vault, поддерживаемая в action Выполнить функцию в
пакет DLL
Теперь в качестве Bot Creator можно использовать переменную Credential Vault или
переменную типа учетных данных для типа данных Number и передать ее в качестве
входного параметра в функцию DLL.

Использование action «Выполнить функцию»

Идентификатор файла, поддерживаемый при проверке разрешения action из
пакет Google Диск (ID обращения к облачному сервису: 00777716)
action Проверить разрешения из пакет Google Диск теперь поддерживает параметр
Идентификатор файла для ссылки на файлы, доступные в папке Shared with me на
Google Диске. Указав ID файла, вы можете проверить доступ для Чтения, Записи или
Удаления файлов в папке Shared with me на Google Диске.

Пакет Google Диск

Новый пакет компонентов учетных данных
Теперь можно использовать action Присвоить в пакет «Учетные данные» для присвоения
небезопасной строки или переменной непосредственно переменной учетных данных.

пакет «Учетные данные»

Безопасность веб-служб поддерживается в пакет Веб-служба SOAP  (ID обращения к
облачному сервису: 00481836)
Теперь в качестве Bot Creator можно предоставлять переменные учетных данных в
необработанных данных action Веб-службы SOAP. Вы можете создать переменную учетных
данных, сопоставить учетные данные с именем ссылки в модуле сопоставления учетных
данных и использовать имя ссылки в необработанных данных. Поскольку это гарантирует, что
все данные, связанные с безопасностью, могут быть определены в Credential Vault, а учетные
данные могут быть использованы в боты, можно безопасно развертывать задачи без ущерба
для безопасности.

Пример использования действия веб-службы SOAP

Новый параметр в пакет Веб-служба SOAP
Для извлечения значений из ответа SOAP используйте параметр Создать Xpath в пакет
Веб-служба SOAP. Теперь вы можете указать выражение Xpath или выбрать соответствующий
узел из тела ответа и сохранить полученные данные в переменной.

Сервер Outlook поддерживается в actions «Изменить состояние», «Сохранить
сообщение эл. почты» и «Удалить»  (ID обращения к облачному сервису: 00544534,
00557623, 00642506, 00659724, 00763565, 00680801, 00803975, 00818304, 00819362)
Чтобы автоматизировать задачу, в пакет Эл. почта можно установить соединение с сервером
Outlook для actions Изменить состояние, Сохранить сообщение эл. почты и Удалить.

Чтение электронной почты из общего почтового ящика в Microsoft Outlook (ID
обращения к облачному сервису: 00728579, 00831622)
Для автоматизации задач, связанных с электронной почтой, теперь вы можете выбрать
общую учетную запись в Microsoft Outlook, чтобы сообщения электронной почты можно было
читать из общего почтового ящика.
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Новые типы кодировок, поддерживаемые в action «Записать в файл» из пакет
Таблица данных (ID обращения к облачному сервису: 00767158)
При использовании action Записать в файл для записи данных из переменной типа Таблица
в файл CSV или TXT теперь можно использовать указанные ниже типы кодировок из списка.
• UTF-8: Работает как UTF-8 без BOM
• UTF-8 с BOM (ранее назывался UTF-8)
• UTF-16LE
• Shift-JIS (японская кодировка)

Функции автоматического сохранения в Bot editor
В Bot editor при использовании actions для создания автоматизации, когда бот не сохраняется
вручную, выполняется автоматическое сохранение и бот теперь автоматически сохраняет
изменения для определенных событий.

Прим.:  В настоящее время функция автоматического сохранения доступна только для
определенных событий.

Ниже перечислены некоторые события, поддерживающие функцию автоматического
сохранения.
• Средство записи При создании бот с определенными actions и щелчке по кнопке

Средство записи событие сохраняется, а когда запись завершена, событие сохраняется
автоматически.

• Менеджер переменных. Когда вы создаете или редактируете переменные, чтобы вставить
их в поле action, изменения сохраняются.

Прим.:  Функция автоматического сохранения не поддерживается, когда вы удаляете
переменную или вставляете ее, нажав клавишу F2 для открытия списка переменных.

• Меню действий (вертикальное многоточие): При выборе из этого меню любого action,
например (Пакеты событие сохраняется автоматически. При внесении каких-либо
изменений на странице Пакеты и возврате на страницу Bot editor, событие сохраняется.

• Найти файл. При щелчке по значку Найти файл бот сохраняется, если он не был
сохранен вручную. Кроме того, после щелчка по кнопке Добавить бот сохраняется
автоматически.

• Диалоговые окна. При открытии диалогового окна оно автоматически сохраняется, если в
него были внесены какие-либо изменения.

Прим.:  Автоматическое сохранение срабатывает только для диалоговых окон верхнего
уровня, но не для вложенных диалоговых окон.

• Удаление переменных. При удалении неиспользуемых переменных событие сохраняется.
• Изменение названия Бот. При изменении названия бот событие будет сохранено.

Новая возможность в пакет FTP / SFTP (ID обращения к облачному сервису: 00792346)
Используйте вариант Компонент учетных данных при подключении к серверу типа
Secure FTP для автоматического выполнения задачи. Теперь для аутентификации можно
использовать имя пользователя и пароль.
Connect action
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Усовершенствование AISense Recorder
AISense Recorder теперь поддерживает автоматизацию приложений, использующих
интерфейс на бразильском варианте португальского и сочетание бразильского варианта
португальского и английского языков.
AISense для записи задач из удаленных приложений

Поддержка действия «Сделать снимок привязки» в AISense Recorder
AISense Recorder теперь поддерживает параметр Сделать снимок привязки. При
запуске бот для поиска объекта в приложении, в котором привязка часто меняется, можно
использовать Сделать снимок привязки, чтобы переопределить привязку по умолчанию и
вручную выбрать привязку для обнаружения объекта.
Edit a task recorded using AISense

Улучшенная поддержка при выборе свойства объекта в пакет Средство записи
После записи снимка объекта с помощью Средство записи > Запись action вы можете
выбрать имя свойства объекта из списка доступных свойств, чтобы получить значение
свойства объекта с помощью action Получить свойство. Список включает предложенные
имена свойств из критериев поиска в таблице Свойства объекта.

Пакет Средство записи

Усовершенствование пакет «Число»
• В action Случайная пакет «Число» можно указать и ограничить количество десятичных

разрядов, требуемых в случайном числе, генерируемом на выходе.
• Существующее поле Сохранить результат в числовой переменной теперь

переименовано в Сохранить результат в переменной.

Число пакет

Усовершенствование пакет «Ожидание»
Используйте новую функцию Сделать снимок области в action Ожидать изменения
экрана в пакет «Ожидание» для записи снимка определенной области в приложении,
нарисовав вокруг нее прямоугольник таким образом, чтобы бот автоматически записывал
снимок координат этой области. Вы можете выполнить указанные ниже действия.
• Сделать снимок определенной области в приложении «Окна».
• Выполнить предварительный просмотр изображения на снимке в окне

Предварительный просмотр.
• Восстановить область, если изображение в окне Предварительный просмотр не

соответствует требованиям пользователя.

Координаты переименовываются указанным ниже образом.
• Влево теперь X
• По верхнему краю теперь Y
• Вправо теперь Ширина
• По нижнему краю теперь Высота

Using Wait for screen change action
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Усовершенствование пакет «Строка»
В action Извлечь текст пакет «Строка» теперь вы можете извлечь подстроку из указанной
исходной строки, которая встречается в файле более 1000 раз и до максимального предела
999999.

Усовершенствование условий обработки файлов в пакет «Если»
Теперь можно использовать новое условие Расширение файла из списка Условие в пакет
Если для проверки расширений файлов и последующего выполнения actions на основе
полученных результатов.

Поддержка междоменных iFrame в браузерах Google Chrome и Microsoft Edge
Chromium (ID обращения к облачному сервису: 00825656)
Теперь можно записывать и автоматизировать объекты внутри междоменного iFrame в
браузерах Google Chrome и Microsoft Edge Chromium, используя меню Средства записи >
Запись или параметр Начать запись. После записи объекта внутри междоменного IFrame
путь к кадру по умолчанию сохраняется в свойстве FrameDOMXPath.
Новый FrameDOMXPath определяет путь к кадру, в котором находится объект. Это свойство
необходимо выбрать, чтобы запустить бот для успешной записи объектов на междоменном
IFrame.

Прим.:  Эта функция доступна для боты, создаваемых с помощью версии
2.4.0-20211016-070100 пакет Средство записи, начиная с этого выпуска.

Пакет Средство записи

Поддержка автоматизации Microsoft Edge Chromium с режимом совместимости
Internet Explorer (ID обращения к облачному сервису: 00767502, 00787186)
Теперь вы можете автоматизировать веб-приложения, работающие на Microsoft Edge
Chromium, включив режим совместимости Internet Explorer, используя Universal Recorder, где
запись объектов ведется с помощью технологии HTML.
Record a task with the Universal Recorder

Поддержка глобальных сеансов для итератора цикла на основе Расширенный
Excel
Теперь вы можете использовать параметр Глобальный сеанс при циклическом просмотре
каждой строки в листе Расширенный Excel. Используйте параметр Глобальный сеанс
для совместного использования сеанса Microsoft Excel в нескольких боты, что позволяет
использовать один и тот же лист Excel во всех этих боты.
Using the Open action for Расширенный Excel

Усовершенствование в пакет Расширенный Excel (ID обращения к облачному сервису:
00799071)
Используйте action Открыть из пакет Расширенный Excel, чтобы открывать файлы с
расширением .ods, .htm, .html, .mht, .mhtml, .slk и .pdf.

Расширенный Excel пакет
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Выгрузка определенной версии бот
Чтобы отредактировать бот на странице Автоматизация Control Room, при выгрузке
бот из рабочей области Общие в рабочую область Личные, теперь вы можете выбрать
определенную версию бот вместе с ее зависимостями, используя новые Расширенные
параметры.
Check out a single бот

Новые API-интерфейсы для устройств
Теперь можно распределять устройства по умолчанию, используя новые API-интерфейсы,
введенные в разделе v1/Devices. Выберите: задать или не задавать определенное
устройство в качестве устройства развертывания по умолчанию для указанного пользователя,
используя следующие API-интерфейсы соответственно:
• /runasusers/default
• /runasusers/default/unset

Настраиваемый срок действия API-ключа (ID обращения к облачному сервису:
00763420)
Теперь можно настроить срок действия API-ключа с помощью функции Срок действия
API-ключа доступной в разделе Администрирование > Настройка > Конфигурация
системы безопасности в Automation 360. Можно установить срок действия от 1 минуты до
45 дней.

Сравнение версий Бот
Теперь вы можете сравнивать различные версии боты в вашей рабочей области «Общие». Вы
можете использовать параметр Сравнить версии для выбора двух версий бот и сравнить
их на предмет различий, при этом любые изменения в потоке операций будут выделены
для справки. Вы также можете просмотреть различия в действиях, пакетах, триггерах и
переменных в разных версиях.
Compare бот versions

Поддержка меток производства в потоке операций разработки ботов
Теперь можно присвоить Метку производства определенной версии бот. После присвоения
метки вы можете запускать или экспортировать боты с использованием выбранной
вами версией бот. Вы можете выбрать версию, связанную с меткой производства, для
планирования, запуска, постановки в очередь и активации потока операций разработки бот.
Assign label to a бот

Доступ к ресурсу обучения и сертификации по RPA в Automation Anywhere
Теперь в Справочный центр Automation 360 добавлена прямая ссылка на ресурс обучения и
сертификации по RPA в Automation Anywhere.
Automation Anywhere University: RPA Training and Certification (A-People login required)
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Рекомендация для Bot Scanner
В настоящее время для Bot Scanner рекомендуется приступать к миграции (с проверкой или
действиями или без таковых), когда может быть перенесено 95% или более 95% ваших
боты.

Присвоение переменной компонента учетных данных переменным, не
относящимся к типу «компонент учетных данных», для перенесенных боты
Для перенесенных боты Automation 360 больше не ограничивает присвоение переменной
компонента учетных данных переменным, не относящимся к типу «компонент учетных
данных», небезопасным (незащищенным) способом. Поэтому теперь вы можете успешно
запускать перенесенные боты, которые используют команду Запустить логику для
передачи переменной компонента учетных данных в переменную, не относящуюся к типу
«компонент учетных данных», небезопасным способом.

Усовершенствование пакет Средство записи
Алгоритм поиска для пакет Средство записи теперь усовершенствован таким образом, что
при запуске бот объект будет записан только в том случае, если его свойства соответствуют
точному критерию поиска, который был выбран в таблице Свойства объекта. Если свойства
объекта не точно соответствуют критерию поиска, то работа бот завершится с сообщением об
ошибке. Однако, если критерий поиска включает символ подстановки, то бот запишет первый
объект, соответствующий критерию.
Например, чтобы захватить текстовое поле из приложения, которое имеет три текстовых
поля с именами firstname1, firstname2 и firstname3, если параметр Имя HTML был
выбран в качестве критерия поиска, введите значение firstname в поле имени HTML
и запустите бот, после чего работа бот завершится с сообщением об ошибке, поскольку
текстовое поле с именем HTML firstname не существует. Однако если в поле Имя
HTML ввести firstname* и запустить бот, то бот запишет первое текстовое поле,
соответствующее критерию.
Ранее при отсутствии объектов, свойства которых точно соответствовали бы критерию
поиска, вместо того, чтобы выдать ошибку, бот записывал первый объект, свойства которого
частично соответствовали критерию поиска. Например, в предыдущем примере, если вы
выбираете Имя HTML в качестве критерия поиска, ввода значения firstname в поле Имя
HTML и запуска бот, то бот, не завершая работы, выполнит запись первого текстового поля,
которое частично соответствует критерию поиска.

Прим.:  Это усовершенствование доступно для боты, создаваемых с помощью версии
2.4.0-20211016-070100 пакет Средство записи, начиная с этого выпуска. Чтобы использовать
эту функциональность в боты, созданных с помощью предыдущей версии пакет, необходимо
заново создать объекты.
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Усовершенствование пакет «Файл»  (ID обращения к облачному сервису: 00755631,
00780237)
• В action Копировать файл Control Room пакет «Файл» новый параметр

Динамический путь к файлу в поле Файл Control Room теперь позволяет
использовать переменные в пути к файлу для копирования файла из репозитория Control
Room, в котором путь к файлу является динамическим.

• Теперь некоторые действия и свойства пакет «Файл» обновлены, как показано ниже:
• action Копировать теперь переименовано в Копировать файл рабочего стола.
• action Загрузить файл CR теперь переименовано в Копировать файл Control

Room.
• В action Копировать файл Control Room переименованы указанные ниже поля.

• Поле Выберите файл Control Room теперь переименовано в Файл Control
Room.

• Поле Сохранить файл CR в папку теперь переименовано в Путь к целевому
файлу.

• В action Копировать файл Control Room поле Файл Control Room теперь есть два
новых параметра: Статический путь к файлу и Динамический путь к файлу.
Параметр Статический путь к файлу является существующей функцией поля
Файл Control Room, которая позволяет просматривать репозиторий Control Room и
выбирать файл. При просмотре репозитория с помощью Статический путь к файлу
файлы с расширением .bot больше не отображаются.

Прим.:  Переименование actions в файле пакет не влияет на существующие боты, которые
используют эти actions.

Файл пакет

Изменения в действии «Подключить» в пакет FTP / SFTP (ID обращения к облачному
сервису: 00792346)
В action Подключить вносятся следующие изменения:
• Тип сервера SSH FTP теперь переименован в Secure FTP.
• Если выбрать тип сервера FTP Secure, можно видеть, что тип аутентификации Учетные

данные пользователя теперь переименован в Имя пользователя и пароль.

Прим.:  Начиная с этого выпуска, использование учетных данных Secure FTP в FTP Secure
вызывает сбой бот. Вместо этого для подключения к серверу Secure FTP рекомендуется
использовать параметр Компонент учетных данных, доступный для серверов типа
Secure FTP.

• Изменения в action Подключить: Если создать боты, используя action Подключить
в Automation 360 v.22 и более ранних версий, и обновиться до v.23, то из-за изменений
в интерфейсе в боты некоторые параметры action Подключить отображаются как
устаревшие. Тем не менее, существующие боты продолжают успешно работать. Новые
боты рекомендуется создавать, используя action Подключить, доступное начиная с этого
выпуска.
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Поддержка копирования одной или нескольких переменных (ID обращения к
облачному сервису: 00549368, 00751052, 01260498)
Теперь вы можете скопировать одну или несколько переменных из одного бот, а затем
вставить их в другой бот. Ранее при выполнении операции копирования также копировались
actions вместе с переменными.

Поддержка зарезервированных символов в различающихся именах (DN) для
Active Directory Control Room (ID обращения к облачному сервису: 01133364, 00952301)
Теперь в DN или имени пользователя Control Room, настроенной для пользователей Active
Directory, можно использовать зарезервированные символы, такие как запятая (,).

В приведенной ниже таблице перечислены исправления и сборки, в которых были сделаны эти
исправления. Сборка 11513 является последней сборкой и включает в себя исправления из
предыдущих сборок.

Исправления

Сборка ID обращения к
облачному сервису

Описание

11513 00797196, 00818347 Обновления в API рабочего пространства
«Личные» ( /v2/repository/workspaces/
{workspaceType}/files/list):
• Отображать список ботов из рабочей области

«Личные» могут только авторизованные
пользователи рабочей области «Личные».

• Администратор не может отображать список
ботов рабочей области «Личные».

• Пользователи, авторизованные только
для рабочей области «Общие», не могут
отображать список личных ботов.

• Один авторизованный пользователь рабочей
области «Личные» не может отображать
файлы рабочей области «Личные» другого
пользователя.

11513 00808478,
00814198, 01260666

Если вы являетесь администратором Control Room,
то выполняемое вами изменение разрешения
на просмотр некоторых папок бот, с тем чтобы
их могли просматривать только определенные
пользователи, теперь применяется корректно.
Ранее изменения, вносимые в разрешения на
просмотр папок бот, не применялись надлежащим
образом.

11513 При обновлении с Automation 360 v.22 до v.23
фоновые задания, связанные с синхронизацией
облачного сервера лицензий, больше не
удаляются из-за неправильного имени задания
лицензии.
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Сборка ID обращения к
облачному сервису

Описание

11513 01753484, 01754939 Теперь вы можете развертывать (как
планировать, так и запускать) боты из Control
Room без каких-либо проблем, если у вас
есть разрешение на выполнение действия
Просмотреть пакет.

Прим.:  Для развертывания (как планирования,
так и запуска) боты из Control Room требуется
разрешение на выполнение действия
Просмотреть пакет.

11513 -- Теперь при установке или обновлении до
Automation 360 v.23 для развертываний On-
Premises файлы журналов обновляются для
всех служб без каких-либо проблем. Ранее
файлы журналов для некоторых дополнительных
служб не обновлялись с указанием какой-либо
информации или метки времени для действий.

11486 00793800 При переходе на этот выпуск проблемы,
связанные с JRE при установке Control Room на
машины, использующие серверы Microsoft Hyper-
V, теперь устранены. The following error no longer
occurs: Unknown Failure. Please check
 the database login credentials and
 check if this machine has a network
 connection to the database server.

11486 00815340 При указании имен папок пользователей,
содержащих подобные части или использующих
соглашения об именовании, больше не
отображаются папки, для которых используются
общие соглашения об именовании без
присвоенных или определенных разрешений
пользователя.

11486 00836898, 01259938 Теперь утилита миграции в облако включает в
себя усовершенствованную логику, позволяющую
успешно загружать данные даже при
подключении к сети через прокси-сервер.

11486 00817173 Теперь можно выполнять функцию запуска DLL,
когда для входного и выходного параметров
установлено значение String, а значение даты и
времени теперь успешно передается как параметр
«Строка». Ранее значения даты и времени
преобразовывались и отображались не так, как
ожидалось.
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Сборка ID обращения к
облачному сервису

Описание

11486 00754305, 00769128 Теперь тегирование конфигурации работает
правильно на основе настроек, заданных
в файле nodemanager-logging.xml. Ранее
журналы менеджера узлов и программы запуска
ботов очищались либо через два дня, либо
если количество журналов увеличивалось на
определенную величину из-за проблем с тегами,
подобных перечисленным ниже. «IfLastModified
age» и «DirectWriteRolloverStrategy»

11486 Если вы решите выбрать или отменить выбор
всех боты и зависимостей, вы можете установить
или снять флажок Выбрать все без каких-либо
проблем. Ранее снять установленный флажок
Выбрать все было невозможно. В результате вам
приходилось отменять выбор боты и зависимостей
по отдельности.

11486 00798037, 00814184 Метки Управление и Администрирование на
панели навигации теперь обновлены и позволяют
различать роли и разрешения на указанных ниже
языках. Упрощенный китайский, традиционный
китайский, японский и корейский языки.

11486 01218053 Теперь можно импортировать родительские и
дочерние боты с зависимостями, даже если у вас
нет разрешения на доступ ко всем папкам.
Ранее, если пользователь без разрешения на
доступ к папке импортировал родительских и
дочерних боты с зависимостями, зависимости
между ними терялись.

11486 01046249 Во время миграции с Enterprise 11 на Automation
360 дублирующие записи больше не создаются ни
для одной из существующих команд.

11486 -- Теперь можно успешно мигрировать бот Enterprise
11, который использует команду Запустить
задачу, даже если флажок В случае ошибки
перейти к следующему повторению не
установлен.
Ранее родительский бот прекращал выполнение,
если дочерний бот сталкивался с ошибкой.
Теперь, если этот параметр не выбран,
обработчик ошибок обеспечивает успешное
выполнение миграции, даже если в дочернем бот
произойдет ошибка.

11486 -- Если раньше использовалось action Перейти
к ячейке из пакет Расширенный Excel в бот
Enterprise 11, то теперь эта настройка сохраняется
при переносе ее в Automation 360.
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Сборка ID обращения к
облачному сервису

Описание

11486 00779016 Теперь можно использовать пакет XML, чтобы
открывать любые xml-файлы без каких-либо
проблем после миграции на Automation 360.

11486 00794202 Теперь можно без каких-либо проблем
мигрировать боты Enterprise 11 в Automation 360 с
помощью команды Если.

11486 00790245 Теперь после миграции на Automation 360 можно
без каких-либо проблем использовать action
Веб-служба SOAP из пакет Веб-служба SOAP.

11486 00795518, 00832462 Если раньше использовалось action Удалить
ячейки из пакет Расширенный Excel в бот
Enterprise 11, правильные адреса ячеек теперь
отображаются при его миграции в Automation 360.

11486 00808601 В перенесенных боты, которые включают в себя
actions «Извлечь» и «Подстрока» из Операция
строки, больше не возникает ошибка, если
входная строка пуста.

11486 00807945, 01258127 Если мигрировать боты Enterprise 11 с помощью
команды Обработка ошибок, больше не возникает
ошибка, если в значении пути к файлу в
переменной в Снепшот и Записать в файл
отсутствует расширение файла. После миграции
файл «Снепшот» теперь сохраняет файлы с
расширением .png, а Записать в файл — с
расширением .txt.

11486 00777395,
00807705, 00814087

Процесс миграции теперь добавляет Окно
> Установить заголовок action для всех
условий ElseIf-окно существует. Этот параметр
позволяет сделать заголовок окна динамическим,
избавляя вас от необходимости заново подбирать
заголовок окна при его изменении.

11486 00820094, 01019195 После миграции на Automation 360 с Enterprise
11 или Enterprise 10 ошибка снепшота
Обработчик ошибок теперь записывается
по пути к изображению Снепшот. Если путь к
изображению снепшота указан как переменная,
то ошибка снепшота записывается по пути к
приложению по умолчанию.

11486 00810389 Теперь можно мигрировать боты с переменными,
имена которых начинаются с arrayRows
или содержат этот набор символов. Ошибка
переполнения стека больше не возникает, и боты
успешно мигрируют.
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11486 00795347 Теперь при выполнении action Запуск DLL ваши
данные успешно копируются из одного листа Excel
в другой, даже если .Net DLL использует механизм
OLE (например, буфер обмена) для копирования
данных. Ранее при копировании данных из одного
листа Excel в другой возникало исключение,
связанное с потоком.

11486 00787562 После миграции на Automation 360 в большом
бот Enterprise 11 (с 2000 или более командами)
больше не возникает ошибка предварительной
обработки Code too Large for try
 statement (Слишком большой код для
инструкции try), когда бот используется в
Automation 360. Однако если перенесенный бот
содержит команду Цикл или Триггерный цикл с
дочерней командой Продолжить или Прервать,
то при запуске бот все равно может возникнуть
ошибка предварительной обработки.

11486 00782594, 00786968 При миграции на Automation 360 в бот Enterprise
11 с большими размерами массивов больше не
возникает ошибок кучи Java. Если общий размер
массивов в одном бот превышает пороговое
значение размера массива, то переменные
массива мигрируют как есть, пока не будет
превышено пороговое значение. Однако
оставшиеся переменные массива мигрируют как
переменные таблицы без значения по умолчанию
с использованием функции База данных >
таблица action.

11486 00792346 Если ваш бот Enterprise 11 был настроен
использованием Secure FTP без Проверки
подлинности файла ключа, теперь процесс
миграции соответствующим образом настраивает
бот с использованием типа сервера Secure
FTP в Automation 360. Ранее процесс миграции
настраивал бот с использованием типа сервера
Secure FTP неправильно.

11486 -- Пользователи с ролью AAE_Bot Migration
Admin больше не сталкиваются с проблемой при
миграции боты с использованием Bot Migration
Wizard.

11486 -- Bot Migration Wizard теперь отображает
правильное количество MetaBots на экране
Выберите ботов для переноса.

11486 -- Enterprise 11 боты больше не вызывает
ошибку, когда переменная, сопоставленная для
родительского бот и дочернего бот недоступна ни
в одном из боты.
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11486 00729719, 00959356 Появилась возможность добавлять или обновлять
SAP автоматизации с помощью action Запись
из пакета Средство записи, когда сценарии SAP
отключены в бот Enterprise 11.

11486 00639940, 00770561 Если процесс миграции завершился неудачно,
в окне Все переносы теперь отображается
соответствующий статус неудачно. Ранее, когда
процесс миграции завершался с ошибкой из-за
недействительных учетных данных устройства, на
экране отображалось, что процесс миграции идет,
но в Журнале аудита отображался правильный
статус.

11486 00840456 Процесс миграции больше не завершается
с ошибкой при миграции MetaBot, который
содержит логику с лишним символом пробела в
конце имени.

11486 00786646,
00808600, 00822029

Работа перемещенного бот больше не
завершается с ошибкой, если он содержит
команды, выполняющие действия во
всплывающем окне браузера.

11486 00777467 Перемещенные боты больше не завершают работу
с ошибкой при выгрузке в Automation 360 из-за
недопустимого выражения, включаемого в код в
процессе миграции.

11486 00786002 Теперь файлы .atmx и .mbot можно удалять
из Control Room при наличии всех необходимых
разрешений.

11486 00796725 Работа Bot Scanner больше не завершается
с ошибкой при сканировании бот, в котором
заголовок окна задан с помощью переменной в
скобках.

11486 00790861, 00836849 Работа перенесенных боты Enterprise 11 или
Enterprise 10 больше не завершается с ошибкой
при использовании команды Запустить логику
для запуска логики MetaBot, местоположение
логики указано вплоть до папки, непосредственно
содержащей эту логику. Например, допустим,
что у вас есть MetaBot с именем Finance1 и вам
требуется запустить Logic1, которая доступна в
MetaBot в папке Metabots\Logics\Finance.
Раньше, если вы указывали только Metabots
\Logics\Finance вместо полного пути к
логике (Metabots\Logics\Finance\Logic1),
возникала ошибка.
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11486 00804550 Теперь можно импортировать боты из
производственной среды Enterprise 11 в среду
разработки Automation 360, даже если эти боты
включают в себя идентификатор пользователя,
который выгрузил бот в Enterprise 11.

11486 -- При поиске боты с указанными ниже символами
теперь в результатах поиска отображаются боты.
r$@1&#klu%)((}{,'!~`$^&()_-+=[]

11486 00729393 После миграции с Enterprise 11 на этот выпуск
можно просматривать вложенные папки бот в
своей рабочей области Общие Control Room на
странице Автоматизация.

11486 -- После миграции с Enterprise 11 на этот выпуск
можно, используя API-интерфейс Repository
Manager, загрузить боты в рабочую область
«Общие» Control Room из папки, для которой
задано разрешение Загрузить. В коде ответа API
больше не отображается следующее: "upload":
false.

11486 01032367, 01066099 Проблема с окна хода развертывания бот теперь
исправлена. Ранее даже после завершения
запуска бот окно отображалось в течение
длительного времени (например, более 10 секунд
в некоторых случаях).

11486 00826923,
01081380, 01259907

После миграции с Enterprise 11 на этот выпуск
теперь можно добавлять рабочие операции
в очереди с помощью API рабочей нагрузки
посредством AWS Lambda. Ошибка переполнения
стека (StackOverflow) больше не появляется в
журналах Control Room.

11486 00801810 Теперь при обновлении Automation 360 On-
Premises до этого выпуска устройства Bot Agent
остаются в подключенном состоянии. Ошибки
WebSocket больше не генерируются в файле
C:\ProgramData\AutomationAnywhere
\BotRunner\Logs\Node_manager.log.
Ранее при обновлении с Automation 360 v.19
(Сборка 8147) до Automation 360 v.21 (Сборка
9664) сообщалось о некоторых проблемах, когда
устройства Bot Agent оставались в отключенном
состоянии, и ошибки WebSocket генерировались
даже без каких-либо изменений конфигурации
прокси.
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11486 00831028,
00830336,
00827031,
00832413,
00833089,
00833436,
00832850,
00839997, 00849904,
00857296,
00831062,
00833436,
01140913,
01145306,
01252819,
01127960,
01256324, 01257414,
01258281, 01263606

Теперь при обновлении Control Room, которое
с помощью Active Directory настроено на этот
выпуск, можно использовать параметр входа
в Windows, и следующая ошибка больше не
возникает: java.lang.NoSuchMethodError.

11486 00719407 Для развертываний On-Premises, если вы
настраиваете несколько IP-адресов для узлов
Control Room в кластере, основной IP-адрес
теперь настраивается автоматически. Больше не
нужно вручную настраивать основные IP-адреса в
файле cluster.properties.

11486 Во время установки Bot Agent, если закончилось
место на диске, нажмите OK в окне
Заканчивается место на диске, мастер
возвращает предыдущее окно Тип настройки,
чтобы можно было отменить установку Bot Agent.
Раньше при нажатии кнопки OK в окне
Заканчивается место на диске, мастер
отображал несколько окон.

11486 -- При автоматическом обновлении предыдущего
выпуска Bot Agent до этого выпуска можно
одновременно выполнять различные операции,
такие как запуск боты, конфигурирование
настроек устройства в Control Room и обновление
Control Room. Больше не требуется перезапускать
службу Bot Agent из диспетчера задач.

11486 00781135 После установки Bot Agent в устройстве
пользователя при перезапуске Bot Agent
папка глобального кэша (C:\ProgramData
\AutomationAnywhere\GlobalCache\) больше
не удаляется.
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11486 00709309, 00766163 Теперь вы можете обновить Control Room,
установленный на Linux, до этого выпуска,
и служба масштабируемого поиска теперь
успешно запускается. Ранее обновление не
удавалось, поскольку служба не запускалась
и отображалось указанное ниже сообщение.
Elasticsearch service fail to start
during certificate retrieval process
(Службе масштабируемого поиска не удалось
запуститься во время процесса получения
сертификата).

11486 00742074 Распределение лицензий для пользователей,
настроенных на использование
многопользовательских устройств, теперь
соблюдается при одновременном развертывании
бот на необслуживаемых Bot Runner.

11486 00822176 На многопользовательских устройствах теперь
можно создать сеанс RDP, использующий
пользовательский порт. До этого, если вы
настраивали многопользовательское устройство
на использование пользовательского порта для
развертывания на основе RDP, развертывание не
удавалось.

11486 00806583, 00805381 Если выполняется развертывание на базе
RDP на устройстве, FreeRDP больше не дает
сбоев при подключении к серверу Windows для
лицензирования RDS для каждого устройства.

11486 -- Если развертывать боты с помощью триггеров
событий и устанавливать Bot Agent на устройстве
в качестве пользователя без прав администратора
для себя или локального администратора,
Bot Agent теперь обновляется автоматически.
Устройство больше не отображается в Control
Room как отключенное.

11486 00803434 Теперь решены проблемы с изменением
поведения HTTP-клиента Jetty в балансировщиках
нагрузки с пользовательским правилом для
заголовков хостов с целью маршрутизации
запроса. Регистрация устройств теперь не
приводит к сбоям, а номера портов добавляются к
хосту, если используются порты по умолчанию.

11486 00815334 Проблемы производительности, связанные
с входом в систему Control Room, а также с
редактированием и запуском боты в Cloud Control
Room, теперь устранены.
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11486 00543141,
00674098,
00714238,
00744991, 00750325

Теперь благодаря интеграции со Splunk и
усовершенствованиям системного журнала
можно пересылать журналы аудита на удаленные
серверы Splunk и просматривать журналы аудита
на информационных панелях Splunk.

11486 00776569 Теперь, если при работе запущенного
бот возникает ошибка, то отображается
соответствующее сообщение об ошибке при
предварительной обработке или во время
выполнения. Ранее сообщение об ошибке при
предварительной обработке или во время
выполнения отображалось даже в том случае,
если бот не содержал ошибки или если бот был
пустым.

11486 00781638,
00805371, 00804784

Проблемы с выгруженным бот и его клоном
теперь решены. Если один пользователь
выгружает бот, вносит изменения и загружает бот
в систему, клон бот в рабочей области Личные
другого пользователя теперь обновляется с
учетом изменений.

11486 00784252 Если регистрировать боты в рабочей области
Общие Cloud Control Room в подпапках без
привилегий администратора Control Room, то
загрузка папок бот в Control Room больше не
занимает много времени.

11486 00786716,
00801631, 01189873

При использовании action Загрузить в пакет
«Браузер» для загрузки файла с веб-адреса
URL больше не возникает ошибки. Ранее, если
веб-адрес URL содержал обратную косую черту в
конце или символы пробела в начале или конце,
бот не мог загрузить этот файл.

11486 00783197, 00818698,
00820666

Если используется action Присвоить из
пакет «Число» для присвоения десятичных
цифр существующей числовой переменной,
ошибки больше не возникают независимо
от региональных настроек устройства на
компьютере.

11486 00778496 Теперь можно успешно импортировать архив бот
в рабочую область «Общие», даже если архив
создает папку System в папке Bots.

11486 00774026 Если использовать action CSV/TXT > Открыть и
action Task Bot >  Запустить для поиска файла
или бот с именем, содержащим японские символы,
проблемы больше не возникают.
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11486 00761035, 00786113 Теперь можно использовать action Средство
записи > Запись для записи объекта в окне
с древовидным представлением и пытаться
получить свойство Имя элемента этого объекта
с помощью action Получить свойство. Ранее
при выполнении бот средство записи успешно
записывало объект в окне, но ему не удавалось
получить имя элемента этого объекта в выходных
данных.

11486 00763925 Больше не возникает проблема, когда вы
используете action Разделить пакет «Строка»
для разделения исходной строки, содержащей
любую комбинацию символов Юникод.

11486 00767074 Если в Internet Explorer использовать action
Браузер >  Открыть, чтобы открыть новое окно
или вкладку, новое окно или вкладка теперь
отображается перед другими окнами, которые
были открыты не администратором.

11486 00819664 Теперь вы можете создавать боты, используя
action Веб-служба SOAP. Вызовы XML больше
не возвращают поврежденные данные, когда
ответ SOAP содержит XML-документ в качестве
внутреннего элемента.

11486 00748494,
00829735, 01018622

При развертывании бот содержащего триггеры
электронной почты, проблемы больше не
возникают. Теперь при отправлении каждого
сообщения электронной почты бот успешно
срабатывает и запускается. Ранее триггер
электронной почты срабатывал только при первой
отправке сообщения электронной почты, а для
последующих сообщений электронной почты бот
не срабатывал и не запускался.

11486 -- Измерение Запуски Task Bot на Главной
странице информационной панели Control Room
теперь отображает правильное количество.
Ранее измерение Запуски Task Bot отображало
нулевое значение, даже если вы запускали боты
из одного и того же интерфейса Control Room.

11486 00824309 В action Выполнить хранимую процедуру из
пакет База данных, когда вы щелкаете Добавить
параметр для предоставления входного или
выходного параметра, метка поля типа параметра
теперь отображается как Тип параметра. Ранее
метка для поля типа параметра отображалась
некорректно.
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11486 00810212 Когда вы используете action Запустить из пакет
TaskBot и выбираете параметр Несколько
переменных в поле Сохранить результат
в переменной, имя переменной теперь
отображается в правильном регистре. Ранее имя
переменной отображалось в нижнем регистре,
даже если имя переменной было создано с
использованием верхнего регистра.

11486 00796913, 00836389 Теперь вы можете использовать action
Переместить все из пакет Эл. почта, чтобы
переместить несколько писем из папки
«Входящие» в другую папку. Ранее action
Переместить все не могло обрабатывать
большое количество писем из-за нехватки места
на диске.

11486 00798673, 00815700 Больше не возникает ошибка, когда вы
используете action База данныхПодключить
и вводите строку подключения, использующую
аутентификацию Windows, и запускаете action
Выполнить хранимую процедуру, в котором
значение входного параметра превышает
36 символов. Ранее, если длина значения
входного параметра превышала 36 символов,
выводилось сообщение об ошибке.

11486 00799450 Когда электронная таблица Excel открывается
в редакторе SAP и одновременно используется
action Открыть из пакет Расширенный Excel
для открытия файла excel, при запуске бота и
успешном открытии файла Excel ошибка больше
не возникает. Ранее файл Excel, открытый в
редакторе SAP, считался окном по умолчанию,
и поэтому при запуске бот появлялась ошибка с
сообщением о том, что файл Excel не может быть
открыт.

11486 00794102 В пакет Веб-служба REST описание ниже
Присвоить выходные данные переменной
теперь переведено правильно для указанных
ниже языков.
• Японский
• Французский
• Итальянский
• Португальский (Бразилия)
• Китайский (упрощенное письмо)

Ранее описание для этих языков было переведено
некорректно.
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11486 00788920, 00796452 В пакет Эл. почта при использовании action
Подключить для подключения к серверу
Outlook или IMAP теперь вы можете успешно
загрузить вложение электронной почты в
виде файла формата .eml. Ранее при наличии
вложений электронной почты в форматах .xlsx и
.eml загружались только файлы .xlsx.

11486 -- Если создать переменную Dictionary с подтипом
Any и выбрать Дата/время в качестве значения
по умолчанию, теперь при нажатии на значок
времени отображается раскрывающийся
список со значениями времени. Ранее, когда
нажимали на значок времени, чтобы выбрать
время из раскрывающегося списка, значения не
отображались.

11486 00746630 Теперь вы можете создать новую задачу,
используя Расширенный Excel с Циклом, и
выбираете параметр Для каждой строки на
листе (Office 365 Excel) из списка Итератор,
создаете переменную Record и запускаете
бот. Устранена ошибка при редактировании
одного и того же бот и выборе параметра Для
каждой строки на листе (Excel базовый или
Excel расширенный) из списка Итератор.
Ранее при запуске бот отображалась ошибка
предварительной обработки.

11486 00762978 Когда вы используете action Окна > Закрыть,
выбираете Активно в настоящий момент
в качестве заголовка окна, чтобы закрыть
все активные окна, а затем запускаете бот,
всплывающее окно Выключить окна больше
не активируется, даже если на компьютере нет
активных окон.

11486 00805654 action Разделить из пакет «Строка» теперь
позволяет выбрать тип переменной Любое для
хранения выходных значений. Ранее можно было
выбрать только переменную списка.

11486 00761189,
00764563,
00785751,
00794273, 00835194

Проблемы производительности, связанные с action
Выполнить макрос в пакет Расширенный Excel,
теперь исправлены.

11486 00796120 Если использовать action Таблица данных >
Сортировать для сортировки пустого столбца,
бот теперь запускается ожидаемым образом, и не
«зависает». Ранее приходилось останавливать бот
вручную.
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11486 00830011 Если в пакет Расширенный Excel выполнить action
Перейти к следующей пустой ячейке на листе
Excel, память в системе больше не исчерпывается.

11486 00765210, 00790641 Если использовать action Расширенный Excel
> Открыть для открытия файла Excel со сводной
таблицей, ошибки больше не возникают.

11486 00776021 Если использовать action «Открыть» из пакет
Расширенный Excel для открытия рабочей
книги Excel, даже когда в рабочей книге
есть недействительные ссылки, боты теперь
запускаются так, как ожидалось.

11486 00692220,
00785965, 00798035

Проблемы производительности, связанные с
action Записать из таблицы данных из пакет
Расширенный Excel, теперь устранены, и action
теперь лучше работает на листах Excel с большим
количеством данных.

11486 00808137 Формат параметров Дата начала и Дата
окончания в рамках условия Дата теперь
обновлен до ММ/дд/ГГ для указанных ниже
actions с файлами и папками пакеты, где дд
теперь правильно показывает дату:
• Файл пакет

• action Копировать файлы рабочего
стола

• Удалить action
• Печать action
• Печать нескольких файлов action
• Переименовать action

• Папка пакет
• Копировать action
• Удалить action
• Переименовать action

Ранее у параметров Дата начала и Дата
окончания был формат ММ/ДД/ГГ, где в поле
ДД вместо даты выводилось количество дней
года.
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Исправления

Сборка ID обращения к
облачному сервису

Описание

11486 -- Если запустить бот в указанной ниже
последовательности actions, файл успешно
удаляется в конце последовательности:
1. action CSV/TXT > Открыть, чтобы открыть

файл .csv
2. action «Цикл» в другом action «Цикл» для

получения значений из файла .csv
3. action CSV/TXT > Закрыть, чтобы закрыть

файл
Здесь все actions используют один и тот же
сеанс по умолчанию.

4. action Файл > Удалить, чтобы удалить файл

Ранее файл не удалялся, поскольку бот не мог
закрыть сеанс по умолчанию.

11486 01164436,
01209626,
00975390,
01080879,
01254846,
01256132,
01255004,
01263774,01253240

Если для захвата элементов управления
с помощью технологии HTML в браузере
Google Chrome или Microsoft Edge Chromium и
выполнения бот использовать пакет Средство
записи версии 2.4.0-20211118-080716,
ошибки больше не возникают. Ранее, когда
использовался пакет Средство записи версии
2.3.0-20210806-215200, возникал сбой бот со
следующим сообщением об ошибке: Не удается
найти элемент управления.Условия поиска
не совпадают

11486 00818990 Возможность «Сделать снимок привязки» в
пакет Средство записи теперь поддерживается
для приложения Citrix XenApp. Теперь во время
запуска бот можно выбрать привязку для поиска
объекта в пользовательском интерфейсе и
выполнять действия на ее основе.

11486 00782962 Ошибка больше не возникает при циклическом
просмотре нескольких листов Excel и при
нажатиях клавиш внутри цикла для копирования
и вставки полученных значений в другой лист
Excel. Ранее, когда вы открывали и закрывали
несколько листов Excel в пределах цикла, бот
не мог определить правильный лист Excel для
выполнения action нажатия клавиши.
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Исправления

Сборка ID обращения к
облачному сервису

Описание

11486 -- Теперь можно использовать action Строка >
Импортировать строку из текстового файла
для считывания значений из текстового файла
во время выполнения бот, если для текстового
файла была задана любая из перечисленных ниже
кодировок.
• UTF-16BE
• UTF-8
• ANSI
• Window-1251
• UTF-16LE
• Shift-JIS

11486 -- В Linux после обновления любой более ранней
версии Control Room до Automation 360 v.21,
в Control Room отображается обновленный
интерфейс. Раньше при обновлении до Automation
360 v.21 в Control Room продолжал отображаться
старый интерфейс предыдущей версии.

11486 00816941 Теперь можно запускать боты с очередью на
основе порядка сортировки, который был выбран
для столбца рабочего элемента в шаблоне
рабочего элемента. Ранее боты развертывались
на основе последовательности, в которой рабочие
элементы были вставлены в очередь.

11486 00804330, 00822092 После того как бот развернут на
пользовательском устройстве, на странице
Журнал запусков (Управление >
Запланировано) теперь отображаются
правильные сведения о журнале запусков для бот.

11486 -- Если приостановить и возобновить автоматизацию
рабочей нагрузки после выполнения бот с
очередью в Control Room, записи аудита теперь
фиксируются на странице Журналы аудита.

11486 00803717 На странице Control Room Завершенные
действия в столбце Кем изменено теперь
отображается имя пользователя (Bot Creator или
Bot Runner), который запланировал работу бот на
пользовательском устройстве. Ранее в столбце
отображалось имя пользователя последнего
пользователя бот.

11486 -- При развертывании боты рабочей нагрузки из
Control Room можно запустить автоматизацию
рабочей нагрузки с повышенными полномочиями,
используя параметр Запустить от имени
администратора.

© 2023 Automation Anywhere. All rights reserved.     341



    Automation Anywhere - Learn

Исправления

Сборка ID обращения к
облачному сервису

Описание

11486 00780635, 00791587,
00795559,
00795632,
00797130,
00797113,
00791783,
00765770,
00826805, 01859661

When you update from a previous release, schedules
no longer disappear from a Control Room configured
on a single-node or multi-node environment. Кроме
того, ранее деактивированные расписания больше
не исчезают и активируются автоматически после
обновления.

11486 00974353 Теперь боты рабочей нагрузки можно развернуть
на устройствах Bot Runner, потому что боты,
связанные с очередью, не могут быть удалены.
Ранее у пользователя было разрешение на
удаление боты рабочей нагрузки во время запуска
с очередью.

11486 00830546, 01181402 При вставке рабочих операций для автоматизации
рабочей нагрузки ошибка переполнения стека
Apache Ignite больше не возникает, а сервер
Control Room больше не прекращает работу.

11486 01021889 Когда вы планируете или развертываете
бот из Control Room, если бот не удается
запустить, теперь отправляется уведомление
по электронной почте. Ранее, даже если
администратор Control Room включил настройку
TaskBot прекратил работу из-за неудачи в
Control Room, уведомление по электронной почте
не отправлялось.

11486 00949288 Запланированные боты перестают время от
времени зависать в статусе ожидания выполнения
периодически на странице Действия, а
последующие боты, запланированные для
выполнению, не застревают в очереди.

11486 01253045, 01256337 Теперь каждый запланированный бот
развертывается на устройстве Bot Runner один раз
в день. Ранее некоторые запланированные боты
развертывались на устройстве Bot Runner дважды.

11486 00750399 Теперь вы можете делать снимки объектов из
Microsoft Internet Explorer, запущенного как
XenApp на сервере Citrix Server, на котором
установлено несколько приложений Citrix.

В приведенной ниже таблице перечислены ограничения, выявленные в текущем выпуске.
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Ограничения в этом выпуске

In Enterprise 11, if боты were using windows variable where the window title value did not use the
exact case as that of the application window title, after migration, the боты will fail to execute.
Обходное решение. You can migrate to Automation 360 v.26 release where this issue is fixed or
ensure that you change the case of the window titles in windows variables to match the case of the
window titles and then migrate the боты.

Когда вы выполняете миграцию бот, который использовал action Manage Window Controls,
последняя цифра значения высоты недоступна после миграции. Тем не менее, бот будет
выполнен успешно. (ID обращения к облачному сервису: 01756996)

Когда сеанс Excel активен в SAP, соответствующий процесс Excel запускается в фоновом
режиме. В таком сценарии Automation 360 использует тот же процесс Excel, который запущен
в SAP. Когда вы запускаете бот для автоматизации данных электронной таблицы, Automation
360 успешно обрабатывает первый запрос. Но если Excel закрыт во время выполнения
и отправляется следующий запрос на автоматизацию данных электронной таблицы,
Automation 360 не обрабатывает запрос, поскольку к процессу Excel все еще обращается SAP.
Поэтому для автоматизации данных электронной таблицы не активируется нужное окно. (ID
обращения к облачному сервису: 00815159)

Когда вы запускаете бот, измерение Запуск Task Bot на странице Главной
информационной панели Control Room отображает неправильное количество. Например,
счетчик запусков Task бот на странице Главной информационной панели отображает
значение 39, но после запуска бот вместо 40 отображается количество 42.

(ID обращения к облачному сервису: 01753337) В таблице «В процессе выполнения» функция
сортировки столбцов не может использоваться для отображения списка элементов в порядке
возрастания или убывания.

После миграции, когда вы запускаете родительско-дочерний бот, который имеет общий
сеанс, и используете разные версии пакетов DLL, выполнение бот завершается сбоем и
выводом сообщения об ошибке во время выполнения.

• Вложенные элементы iFrame в браузерах Google Chrome и Microsoft Edge Chromium не
поддерживаются.

• После выполнения действия в приложении или на странице, если в приложение или на
страницу во время выполнения добавляется кадр и этот кадр заполняется, а страница не
обновляется или не перезагружается, элементы в кадре приложения или на странице не
могут быть записаны или воспроизведены до тех пор, пока вы не обновите эту страницу
вручную.

(ID обращения к облачному сервису: 00988580, 01200161) После миграции с Enterprise 11
на Automation 360 вы, возможно, не сможете Выгрузить некоторые боты и зависимости в
рабочую область Общие Control Room.
Обходное решение. Выгрузите родительские боты в рабочую область Control Room Общие.
Зависимости будут автоматически клонированы.
Подробнее см. в разделе Cannot Check Out With Child Dependencies Due To No Versions (A-People
login required).
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Ограничения в этом выпуске

Если вы выполняете обновление напрямую с Automation 360 On-Premises v.20 или v.21 до
этого выпуска, вы можете столкнуться с проблемами при обновлении вашего Bot Agent на
некоторых машинах Bot Runner в указанных ниже сценариях.
• После обновления Control Room состояние устройства продолжает меняться и Bot Agent не

может выполнить обновление автоматически.
• Если файл embedded resources отсутствует, то Средство записи не распознает

элементы пользовательского интерфейса или не захватывает ни один объект в браузере
Google Chrome.

Обходное решение. Перед обновлением до этого выпуска удалите указанные ниже файлы
и папки Bot Agent.
• C:\Windows\System32\config\systemprofile\AppData\Local

\AutomationAnywhere\AA-DB.mv.db
• C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-resources

Для получения дополнительной информации см. Bot agent auto update fails post the Control Room
Upgrade with 'device.connection.lost' (A-People login required) | The recorder is not able to recognize the
GUI elements in Google Chrome browser (A-People login required).

В некоторых случаях, если вы выгружаете бот в рабочую область Общие Control Room
после фильтрации какой-либо зависимости, при экспорте бот вместо отфильтрованных
данных отображаются все зависимости.

(ID обращения к облачному сервису: 00773700) В процессе миграции не удается выполнить
миграцию боты которые содержат более 96 условий в одной команде Если.
Обходное решение. Разделите команду Если на две команды Если в Enterprise 11, а затем
выполните миграцию обновленных бот.

Если создать бот с недопустимыми тегами JSON и action Обработка ошибок
(Попробовать/Выявить) в нем и если Сервис валидации ботов включен (ВКЛ.) на странице
Настройки > Боты, при запуске бот происходит сбой бот из-за ошибки предварительной
обработки.
Обходное решение. В Bot editor откройте бот, который показывает ошибку. Щелкните
любую выбранную строку кода, отредактируйте ее и сохраните. Например, если вы
создали бот, используя action Комментарий, выберите и нажмите action Комментарий,
отредактируйте его, введя пробел в поле комментария, а затем нажмите кнопку Сохранить.
Теперь при запуске бот не отображается ошибка предварительной обработки.

В Веб-служба SOAP не получается выбрать параметр Необработанные данные и с
помощью команды Создать Xpath извлечь значения из ответа SOAP, чтобы сохранить
выходные XML-данные в переменной.
Обходное решение. Введите выражение Xpath вручную вместо использования команды
Создать Xpath в выбранном ответе.

Если попытаться установить безопасное подключение к БД SQL в среде Linux,
выбрав вариант Включить в поле Конфигурация базы данных >  Безопасное
подключение, установщик Linux не сможет импортировать сертификат SSL, и соединение не
устанавливается.
Обходное решение. Выберите вариант Отключить в поле Конфигурация базы данных
> Безопасное подключение. Установщик Linux успешно устанавливает безопасное
подключение к базе данных SQL.
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Ограничения в этом выпуске

В окружении Linux функция загрузки файлов AARI on the web не работает с ошибкой
«Доступ запрещен». Эта ошибка возникает потому, что каталог filestorage не создается
автоматически для хранения файлов.
Обходное решение. Создайте каталог filestorage в Automation 360 и назначьте
соответствующие разрешения, как описано в приведенных ниже шагах.
1. Перейдите по пути к хранилищу Automation 360: /opt/automationanywhere/

automation360/appdata/Server Files

2. Введите указанные ниже в консоли Linux.
a. sudo mkdir storageservice

b. sudo chown -R crkernel:controlroom storageservice

c. sudo chmod -R 775 storageservice

Когда вы обновляете Control Room с предыдущей версии, то измерение Запуски Task Bot
на Главной странице информационной панели не показывает исторический подсчет бот
заданий, которые выполнялись в предыдущей версии. Отображается только количество бот
заданий, запущенных из обновленного Control Room.

Когда вы используете Средство записи для создания снимков объектов в приложениях,
выполняющихся в Microsoft Edge Chromium в режиме Internet Explorer, используйте
условия Средство записи в бот, чтобы проверить, существует ли элемент в приложении,
попробуйте сделать снимок элементов пользовательского интерфейса в приложении на
основе результата условия и запустите бот, тогда бот всегда будет переходить к следующему
action, так как условие Средство записи не может определить местоположение элемента
пользовательского интерфейса в приложении.
Обходное решение. Вместо этого для определения местоположения элемента
пользовательского интерфейса в приложении используйте условие Распознавание
изображений.

Копирование переменных формы между боты с помощью параметра Копировать в общий
буфер обмена не поддерживается.

В приведенной ниже таблице перечислены ограничения из предыдущих выпусков, которые также
применимы к данному выпуску.

Ограничения из предыдущих выпусков

При настройке внешнего хранилища ключей в разделе Интеграция внешнего хранилища
ключей и выборе режима Проверка подлинности SQL для аутентификации базы данных
на странице Сервер базы данных установщика Windows с целью установки Control Room
(On-Premises) происходит сбой установки и отображается указанное ниже сообщение об
ошибке. Сбой при создании таблиц базы данных Control Room.
Обходное решение. Добавьте учетные данные базы данных во внешнее хранилище ключей
и используйте их для настройки базы данных.
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Ограничения из предыдущих выпусков

Недавно созданные пользователи Control Room в Windows для виртуальных машин Google
Cloud Platform On-Premises не могут изменить свой пароль. Параметр контрольных вопросов
недоступен на экране Изменить пароль, и в результате при попытке сохранить пароль
Control Room отображает ошибку.
Обходное решение. Обновите страницу и измените пароль еще раз.

(ID обращения к облачному сервису: 00837271) Если вы выполняете миграцию с Enterprise
11 при использовании базы данных, содержащей большое количество данных репозитория,
установка может завершиться неудачей. Эта проблема возникает из-за того, что во время
миграции обновление Liquibase для нескольких SQL-запросов не выполнено.
Обходное решение. Обратитесь в поддержку Automation Anywhere.

Исправления в системе безопасности

ID обращения к
облачному сервису

Описание

00836486, 00942844,
01264029

Отключен модуль для кэширования, который использовал
аутентификацию по учетным данным.

AARI (Automation Anywhere Robotic Interface)

Новые возможности

Новый фильтр запросов в действиях «Запросы» и «Задачи запросов»
Используйте новый фильтр, который теперь доступен в actions Запросы и Задачи
запросов пакет AARI Web для фильтрации запросов и заданий по названию команды в
веб-интерфейсе AARI.

Фильтр названий групп
Вы можете фильтровать свои задачи и запросы по названию команды на страницах
веб-интерфейса Задача и Запрос соответственно. Выберите метку Группа в фильтре и
выполните поиск по имени группы, чтобы просмотреть команды, назначенные задаче или
запросу.
Filter and search for a request | Фильтрация и поиск задач

Поддержка журналов аудита (ID обращения к облачному сервису: 00801166)
Теперь вы можете просматривать журналы аудита и ссылаться на события, связанные
с запросами, группами, планировщиками, настройками процессов, настройками ботов,
задачами, выполняемыми человеком и задачами, выполняемыми ботом, которые вы создали,
удалили, обновили, отправили или восстановили.

Журнал аудита
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Новые возможности

Усовершенствование назначения задач пользователя в задаче, выполняемой
человеком
В редакторе процессов параметр Автоматически назначить эту задачу в Задаче,
выполняемой человеком предоставляет указанные ниже альтернативы.
• Пользователь, создавший запрос. Задача автоматически назначается пользователю,

создающему запрос в веб-интерфейсе.
• Пользователь, открывающий эту задачу. Задача автоматически назначается

пользователю, который открывает задачу в веб-интерфейсе.

Эта функция помогает уменьшить конфликты при назначении задач самому себе, особенно
в случае специализированных пользователей, таких как Валидатор, для которых действие
открытия задачи эквивалентно назначению задачи самому себе.

Усовершенствование настройки группы
Теперь в группу в веб-интерфейсе AARI можно одновременно добавить несколько
пользователей с одинаковыми ролями (пользовательская роль). Пользовательская роль в
Control Room теперь согласуется с группой в веб-интерфейсе AARI, и расширенная настройка
группы работает указанным ниже образом.
• Пользователям, добавленным с этой ролью, присваивается роль Участник в группе. Роль

не может быть изменена на Владелец или Администратор.
• Вы не можете просматривать этих пользователей на вкладке Пользователи страницы

Группа.
• Если пользователь одновременно является частью роли и добавлен в группу вручную,

его роль в группе будет такой же, как и роль, назначенная ему вручную. Например, если
пользователь является членом клуба, он будет иметь роль Участник, тогда как если
пользователь является владельцем, в группе ему будет присвоена роль Владелец.

• Если пользователь больше не является частью роли, он также не будет являться частью
группы.

Также страница Группа теперь дополнена параметрами навигации в верхней части, чтобы
вы могли перемещаться по различным вкладкам (Общие, Пользователи, Роли, Процессы
и Боты). Используйте вкладки Общие, Пользователи и Роли для создания групп и
добавления в них пользователей. На вкладках Процессы и Боты отображаются процессы и
боты, назначенные группам, соответственно.
Team management | Create an AARI team and assign team roles to members

Поддержка при настройке бота
Администратор AARI может использовать страницу Настройка бота, чтобы просматривать
боты, которые назначены группе, назначать группы бот и редактировать боты для удаления
или переназначения групп. Bot Runner с сопровождением, имеющие право просмотра всех
боты, которые загружены в рабочей области Общие, теперь могут просматривать боты,
которые назначены группам в AARI Assistant.

Бот setup

Усовершенствование логотипа формы
Теперь поле Логотипы в нижнем колонтитуле можно использовать для выбора до двух
отдельных логотипов, которые будут отображаться в нижнем колонтитуле формы во время
работы бот.
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Новые возможности

Добавление правил к различным элементам формы
При создании или редактировании формы в конструкторе форм теперь правила к указанным
ниже элементам формы можно добавлять с помощью вкладки Правила формы.
• Флажок
• Дата
• Документ
• Выпадающее меню
• Метка
• Номер
• Пароль
• Переключатель
• Редактор Rich Text
• Область текста
• Текстовое поле
• Время

Для элементовФлажок и Переключатель правила срабатывают, только если выбраны
соответствующие предустановки. Например, если форма имеет два взаимоисключающих
параметра, таких как Да и Нет, то правила, связанные с этими параметрами, срабатывают
только при выборе одного из двух параметров.

Добавление правил к элементам формы
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Новые возможности

Обновления триггеров
Теперь для запуска a бот доступны указанные ниже триггеры.
• Триггер процесса. Запускает бот, когда статус указанного процесса в Microsoft Windows

удовлетворяет одному из указанных ниже предустановленных заданных условий.
• Запускается
• Останавливается

Добавление триггера процесса
• Триггер службы. Запускает бот, когда статус указанной службы в Microsoft Windows

соответствует одному из указанных ниже заданных условий.
• Запускается
• Останавливается
• Возобновляется
• Приостанавливается
• Выполняется
• Остановлена
• Приостановлена

Добавление триггера службы
• Триггер окна. Запускает бот, когда указанное окно приложения удовлетворяет одному из

указанных ниже заданных условий.
• Открывается
• Закрывается

Добавление триггера окна

Изменения

Усовершенствование пакет «Создать запрос»
В пакет Создать запрос можно просмотреть и выбрать общий процесс, для которого
требуется создать запрос. Благодаря этому усовершенствованию появилась возможность
выбрать общий процесс без необходимости обращаться к администратору AARI для
получения URI общего процесса и вводить URI вручную. Эта функция также упрощает
процесс отображения входных данных для исходных полей формы.
AARI Web пакет

Исправления

ID обращения к
облачному сервису

Описание

00800192 Теперь можно использовать триггер электронной почты для
запуска бот без каких-либо проблем, даже если в качестве
сервера электронной почты используется POP3.
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Исправления

ID обращения к
облачному сервису

Описание

00801428 Теперь можно добавить триггер электронной почты в учетную
запись Gmail для запуска бот для всех новых сообщений
электронной почты.

00736309, 00765069,
00784362

Для документов в формате .csv, .xlsx или .xls теперь
можно использовать триггер файлов, чтобы запускать бот при
изменении документов.

00796697 При загрузке бот связанный с ним личный триггер события
теперь сохраняется.

00802427 С лицензией Bot Creator вы теперь можете просматривать
все запросы и задачи независимо от вашей роли или других
назначенных вам лицензий.

00829282 Теперь при создании запроса в веб-интерфейсе ваш бот работает
должным образом и не сталкивается с проблемами обработки,
такими как статус неактивности, который препятствует работе
вашего бот.

-- Когда в процессе заполняется более четырех элементов
текстового поля формы, документ теперь корректно
отображается в средстве просмотра документов независимо
от состояния элементов текстового поля. Ранее документ не
отображался.

-- Теперь при удалении запрос со вкладки Запрос отправляется в
корзину, а связанная с ним задача со вкладки Задача удаляется.

-- При использовании условий Если/Иначе  типа Дата и
Логический теперь существует паритет в проверке условий
между бот и процессом. Также условие Если/Иначе типа
Строка теперь допускает существования пустых целевых
значений. Ранее при использовании в процессе валидация
условий типов Дата и Логический не поддерживалась, а
целевые значения не могли быть пустыми.

-- Проблемы с элементом Гиперссылка в Задаче, выполняемой
человеком теперь устранены. Элемент Гиперссылка теперь
корректно работает с указанными ниже вариантами поведения.
• Если URL-адрес гиперссылки пуст, то либо во время создания

дизайна, либо при передаче из процесса гиперссылка
становится недоступной. Ранее в качестве гиперссылки
устанавливался адрес домена Control Room.

• Если элемент Гиперссылка используется в Задаче,
выполняемой человеком, которая доступна только для
чтения, данные теперь передаются из редактора процесса в
форму. Ранее данные из редактора процессов игнорировались.
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Исправления

ID обращения к
облачному сервису

Описание

-- Для элемента Время в формах, когда выбраны параметры
Использовать местное время после отображения формы
и Сделать поле обязательным, теперь элемент времени
принимает системное время как значение по умолчанию и может
быть изменен в исходной форме.

В приведенной ниже таблице перечислены ограничения, выявленные в текущем выпуске.

Ограничения в этом выпуске

В веб-интерфейсе отсутствует действие Установить предупреждение и действие
Установить ошибку для элементов Флажок, Выпадающее меню, Переключатель и
Редактор Rich Text.

Для элементов Дата и Время, если дата и время включены в правило, изменения формата
правила не отражаются в разделе правил. В результате при попытке обработать правило с
этими датой и временем выполнение бота завершается неудачей.
Обходное решение. Откройте редактор правил, разверните соответствующие правила и
выберите соответствующее значение данных из календаря перед сохранением. Не изменяйте
формат после того, как элемент даты и времени будет включен в какое-либо правило. Вы
можете также удалить более старые элементы даты и времени.

Если вы используете элемент Выберите файл в ваших формах и выбираете параметр
Сделать поле недоступным для редактирования, элемент можно редактировать.

Если вы запускаете бот, используя команду Участники группы из пакета AARI Web,
отобразится сообщение об ошибке исключения.

В AARI в веб-интерфейсе, если вы создаете переменную с использованием типа Форма в
бот, вы не можете скопировать эту переменную в другой бот, даже при выборе параметра
Сохранить или Заменить.

Когда пользователь является участником группы по роли (пользователь был добавлен в
роль в Control Room, а затем роль была синхронизирована с группой), этот пользователь
не сможет просматривать обновленную информацию в пользовательском интерфейсе
сведений о запросе или задаче. Это связано с тем, что страница Запрос не обновляется
автоматически.
Обходное решение. Чтобы просмотреть обновленные сведения о запросе или задаче,
обновите страницу Запрос.

В приведенной ниже таблице перечислены ограничения из предыдущих выпусков, которые также
применимы к данному выпуску.

Ограничения из предыдущих выпусков

Если при настройке SDS вы создаете запрос на отправку файла, отправка не удается и
отображается сообщение об ошибке SecurityTokenInvalidException.
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Discovery Bot

Новые возможности

УстановкаBot Agent без проблем
Если вы еще не установили программу Bot Agent, теперь вам будет предложено установить
Bot Agent с вкладки Процессы. Чтобы установить Bot Agent, следуйте инструкциям на
экране. После установки, чтобы продолжить запись, вам будет предложено включить
подключаемый модуль Chrome.

Необходимые условия для Discovery Bot

Усовершенствование автогенерируемых возможностей
Теперь можно начать просмотр автоматически созданной возможности вкладки
Возможности, когда для просмотра представлена хотя бы одна запись процесса.
Просмотрите автоматически сгенерированную возможность и при необходимости выберите
создание пользовательской возможности из возможности, сгенерированной автоматически.

Анализ возможностей, преобразование в бот и создание PDD

Новые записи для просмотра для пользовательской возможности
Теперь можно просматривать новые записи, представленные пользователем Discovery Bot
для пользовательской возможности. Вы можете принять или отклонить обновления записи в
рамках потока операций пользовательских возможностей. Этот параметр позволяет быстро
и легко просматривать новые записи в режиме реального времени по мере того, как записи
представляются пользователем для данного процесса.

Анализ возможностей, преобразование в бот и создание PDD

Усовершенствования на странице «Возможности»
Для того чтобы помочь просматривать и анализировать данные для потенциальной
возможности автоматизации, страница возможностей теперь обновлена и включает план
развития возможностей, а также другие графики. Используйте план развития возможностей,
чтобы определить, какие возможности следует автоматизировать в первую очередь.

Анализ возможностей для автоматизации

Загрузить документ PDD со страницы «Записи»
Теперь можно загружать и экспортировать документ PDD со страницы Записи. После
того как вы отправляете запись на рассмотрение аналитику, PDD автоматически начинает
обработку в фоновом режиме. При создании PDD поле изменяет значение с «Обработка PDD»
на Загрузить. Теперь вы можете выбрать загрузку документа в формате Word, PDF или в
обоих форматах. Также бизнес-пользователю на указанный в файле адрес электронной почты
отправляется уведомление. Загрузить документ PDD в формате Word или PDF также можно
для пользовательской возможности из таблицы со списком возможностей.

Анализ возможностей, преобразование в бот и создание PDD
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Исправления

ID обращения к
облачному сервису

Описание

-- Теперь вы будете получать одно уведомление по электронной
почте для PDD, созданных в Automation 360 v.21. Раньше после
обновления до Automation 360 v.22 вы могли получить по
электронной почте несколько уведомлений о PDD, созданных в
Automation 360 v.21.

В приведенной ниже таблице перечислены ограничения, выявленные в текущем выпуске.

Ограничения в этом выпуске

Во время обновления документы PDD не генерируются периодически как для записей, так и
для возможностей.
Обходное решение. Отредактируйте блок-схему для пользовательской возможности, в
которой возникла ошибка, и сохраните эту блок-схему. Или же создайте новую возможность
на основе существующей.

В зависимости от объема памяти, доступного в вашей системе, документ PDD (в формате PDF
и Microsoft Word) может поддерживать до 250 фиксируемых в документе записанных шагов.
Если записывается процесс с более чем 250 шагами, генерация PDD периодически перестает
работать.
Обходное решение. Повторно создайте PDD и щелкните Загрузить.

В PDF-документе PDD для бизнес-пользователей и аналитиков не отображаются символы
Юникод при вводе в поля «Имя возможности» и «Описание шага».

Пользователи облака. Для автоматически созданной или пользовательской возможности в
таблице Записи периодически отображается ошибка.
Обходное решение. Обновите страницу, чтобы обновить таблицу Записи.

Если после сохранения изменений обновить поток операций процесса, добавляя или удаляя
шаги, значения на панели Обзор могут не обновиться с учетом последних изменений.
Обходное решение. Обновите страницу, чтобы обновить и включить последние изменения,
внесенные в значения возможностей на панели Обзор.

Пользователи облака. Создание пользовательской возможности более чем с 250 шагами
не поддерживается.

Пользователи Linux. Раздел блок-схемы записи не отображается в PDD.

Для развертываний On-Premises, когда для настройки Control Room используется
самоподписанный сертификат или сертификат с поддержкой поддоменов, страница
Процессы не загружается.
Обходное решение. Обновите или добавьте сертификат Control Room в хранилище учетных
данных Java на всех ваших машинах Bot Runner для загрузки страницы Процессы.
Add Control Room certificate to Windows certificate stores
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Ограничения в этом выпуске

Для пользовательских возможностей и записей периодически возникает проблема и ошибка
при создании PDD. Получить доступ к PDD и загрузить его будет невозможно, а вместо этого
отобразится сообщение об ошибке Ошибка при создании PDD.
Обходное решение. Только для пользовательских возможностей вы можете либо создать
новую возможность в потоке операций с помощью параметра Сохранить как, либо
отредактировать диаграмму потока операций путем внесения какого-либо небольшого
изменения и сохранить ее. После этого создание PDD будет работать должным образом.

Discovery Bot supports bot conversion to template only. To generate the automation task, you must
manually update or enhance the template generated by Discovery Bot in the RPA workspace. (ID
обращения к облачному сервису: 01840856, 01822803, 01860950)

Feature deprecation for Discovery Bot

Review the deprecated feature to understand how it can impact your automation.

Discovery Bot Aggregated and Comparison options
The Discovery Bot Aggregated and Comparison tabs from the Processes page has been deprecated
as of June 2021. You can use the Opportunities tab to view processes in an aggregated workflow.

IQ Bot

Новые возможности

Document Automation выпущенный в Community Edition
Community Edition теперь предлагает ограниченные возможности из версии Document
Automation. Эта версия интегрирована с Community Control Room. Когда вы создаете
обучаемый экземпляр, IQ Bot автоматически создает RPA боты для извлечения и загрузки
данных и процесс AARI для управления сквозным процессом. Валидация теперь происходит в
задачах AARI.
Используйте IQ Bot Community Edition для извлечения данных из счетов-фактур на
английском языке.
Community Edition

Усовершенствование стандартных форм IQ Bot
IQ Bot теперь предоставляет указанные ниже усовершенствования, связанные со
стандартными формами.
• Теперь можно извлекать данные из таблиц.
• Теперь можно использовать контейнерное развертывание.

Using IQ Bot for standard forms
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Новые возможности

Поддержка CyberArk
Процесс установки On-Premises теперь позволяет пользователям подключаться к CyberArk,
чтобы сохранить свои пользовательские ключи для шифрования и дешифрования данных IQ
Bot.

Прим.:  Эта функция доступна только для новых установок.

Установка IQ Bot в пользовательском режиме

Усовершенствование классификатора
Теперь предусмотрена возможность создавать пользовательские группы документов в
обучаемом экземпляре. Это уменьшает вероятность того, что распознавание текста (OCR)
не сможет обнаружить поля в документе, что заставит классификатор создать группу
документов без необходимости или отправить документ в неправильную группу.

О классификаторе

Просмотр количества приобретенных и загруженных страниц
На информационной панели IQ Bot теперь отображается количество приобретенных и
загруженных страниц за текущий период действия лицензии.

Обзор информационной панели

Изменения

(ID обращения к облачному сервису: 00656822) Теперь интеграция Credential Vault доступна
для паролей в IQ Bot.

Исправления

ID обращения к
облачному сервису

Описание

00727633 При импорте или экспорте обучаемых экземпляров дублирование
записей классификации больше не происходит.

00768600, 00783773,
00815546, 00795424,
00788180

Теперь при импорте существующего архивного файла (IQBA) IQ
Bot вы можете использовать параметр Заменить без каких-либо
проблем.

00770638, 00746545,
00827208, 00746545,
00827208

При импорте архивного файла (IQBA) IQ Bot вы больше не
увидите дублирующихся записей групп.

00773631 (On-Premises) После установки перезапустите сервисы IQ
Bot, используя другого пользователя Windows. До этого
выпуска невозможно было запустить сервисы IQ Bot с
последующей установкой другой учетной записи, что приводило
к несовместимости значения переменной FilePath для наборов
изменений Liquibase.

© 2023 Automation Anywhere. All rights reserved.     355



    Automation Anywhere - Learn

Исправления

ID обращения к
облачному сервису

Описание

-- Теперь можно получить доступ к IQ Bot > Изучение IQ Bot
с использованием усовершенствованного пользовательского
интерфейса. Ранее пользователь не мог вернуться на целевую
страницу Control Room. Теперь пользователи могут перейти на
целевую страницу, щелкнув кнопку «Назад».

00766454 При выполнении действия Управлять своими ботами IQ
Bot больше не отображается неправильный пользовательский
интерфейс для обученных ботов, находящихся в производстве.
Ранее отображалась ссылка для создания бота.

00804476 При обновлении отчета о классификации теперь можно успешно
классифицировать документы в IQ Bot. Ранее из-за того, что имя
поля отчета о классификации содержало более 75 символов,
классификация документов не выполнялась.

-- На странице сводки Обучаемый экземпляр теперь точно
отображается количество неклассифицированных документов и
количество отправленных документов.

00695159 Внутреннее исключение в модуле RemoveLines, из-за которого
документы оставались необработанными, теперь устранено, и
документы больше не остаются необработанными из-за этой
ошибки.

00806557 Теперь вы можете успешно присвоить группу бот и переместить
бот в производство. Ранее в некоторых случаях архив IQBA
содержал несколько боты для одной группы, что делало
состояние бот несогласованным.

- Теперь выходные файлы можно загружать без каких-либо
проблем, даже если во время загрузки в базу данных часто
отправляются запросы API для любого стандартного обучаемого
экземпляра форм.

- Теперь без каких-либо проблем можно использовать action IQ
Bot Extraction, даже если при установке Bot Agent был выбран
параметр Только для меня.

-- Для боты, связанных со стандартными обучаемыми экземплярами
форм, теперь можно успешно загружать большое количество
документов.

00776423, 00829915,
00949561

Теперь для запуска инструмента «Помощник по миграции» на
сервере баз данных можно использовать пользовательский порт
(кроме порта 1433).

-- Когда документы с длинными именами файлов, написанными не
на английском (например, на японском), не работают, проблема
теперь регистрируется в файле bot_launcher.log.

00814577, 00812300,
00823120

Неожиданная ошибка, возникавшая из-за больших неназванных
очередей сообщений RabbitMQ, была исправлена, и теперь
пользователь может переходить на страницу Обучаемые
экземпляры.
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Исправления

ID обращения к
облачному сервису

Описание

-- Служба MLScheduler в Cloud IQ Bot теперь отключена , и
система больше не замедляет свою работу и не перестает
отвечать. Ранее функции автокоррекции и автоподсказки,
которые являются частью MLScheduler, использовали
значительные системные ресурсы и вызывали замедление или
остановку работы системы.

-- Теперь action Обработка документов в пакет IQ Bot Extraction
получает настройки предварительной обработки ABBYY с сервера
IQ Bot и применяет эти настройки к классической стороне
обработки во время выполнения бот.

В приведенной ниже таблице перечислены ограничения, выявленные в текущем выпуске.

Ограничения в этом выпуске

Когда бот перемещается в производство, документы в выходной папке валидатора
становятся недоступными или отображается следующая ошибка: Не найдены проект или
документы.

Обходное решение. Убедитесь, что длина имени файла не превышает 100 символов.

В кластерной установке иногда конкретный документ в производстве становится
недоступным. Кроме того, отображается некорректная сводка по обучаемым экземплярам.
Обходное решение. Еще раз загрузите и обработайте документы, которые не были
успешно обработаны.

В приложении Designer не загружаются некоторые документы для созданной пользователем
группы и результаты их извлечения.
Обходное решение.
1. Перезагрузите приложение Designer.
2. Чтобы получить подробную информацию об извлечении в On-Premises, перейдите

к файлу Settings.txt и увеличьте значение параметра Просмотреть тайм-аут
извлечения.

На странице сведений об обучаемых экземплярах из-за ограничения в 150 символов метки
групп, созданных пользователями, отображаются не полностью.

Если при создании пользователя-администратора IQ Bot указать роль AAE_Basic вместе с
ролью AAE_IQ Bot Admin, такой пользователь-администратор не сможет добавлять новые
группы в обучаемый экземпляр.
Обходное решение. Убедитесь, что вы включили роль AAE_Basic вместе с ролью AAE_IQ
Bot Admin в Control Room.

В случае обучаемого экземпляра стандартных форм, если вы загружаете документ,
содержащий таблицу с недопустимым полем, этот документ отправляется в папку Неудачно.
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Ограничения в этом выпуске

Для действия Конкатенировать изображения в пакете IQ Bot Pre-processor, вывод не
формируется, если имя файла содержит более 256 символов.
Обходное решение. Используйте английские буквы и правила нумерации.

Когда вы используете пакет IQ Bot Extraction вместе с другими командами на основе OCR
(такими как IQ Bot Pre-processor, IQ Bot Classifier, AISense Recorder и Распознавание текста
(OCR)) в одном бот, выполнение бот завершается сбоем.
Обходное решение. Убедитесь, что вы создали отдельные боты для IQ Bot Extraction, и не
запускайте IQ Bot Extraction в сочетании с другими пакеты, которые включают 12.2 Abbyy
OCR.

Из обучаемого экземпляра пользовательского типа домена с ручными группами, когда вы
экспортируете файл IQBA в другой экземпляр, Метка группы «ручная» не экспортируется.
Без метки ручной группы трудно отличить группы, созданные системой, от групп, созданных
вручную, в новых обучаемых экземплярах.

В приведенной ниже таблице перечислены ограничения из предыдущих выпусков, которые также
применимы к данному выпуску.

Ограничения из предыдущих выпусков

Если у вас есть документ с большим количеством страниц (более 100), то при нажатии
кнопки Посмотреть результаты извлечения для существующего обучаемого экземпляра
периодически отображается сообщение об ошибке.

Bot Insight

Изменения

Чтобы изменить язык в Bot Insight, необходимо применить языковые настройки браузера или
операционной системы, настроенной на выбранный язык.

Интернационализация, локализация и поддержка языков

Исправления

ID обращения к
облачному сервису

Описание

00799262, 00826862 Больше не возникает ошибка, когда вы запускаете бот, в имени
которого содержатся специальные символы, и команду анализа.
Ранее при выполнении боты с символом амперсанда (&) в имени
и запуске команды анализа возникала ошибка.

Расчет на информационной панели устройства теперь исправлен
и для точного максимума показывает значение 100% для
ежедневного использования. Ранее из-за ошибки в расчетах
на информационной панели устройства для ежедневного
использования отображалось более 100%.

В приведенной ниже таблице перечислены ограничения, выявленные в текущем выпуске.

© 2023 Automation Anywhere. All rights reserved.     358



    Automation Anywhere - Learn

Ограничения в этом выпуске

Bot Insight не совместим с Microsoft Internet Explorer 11. Список альтернативных браузеров см.
в разделе Требования к браузеру для доступа к Рабочая область RPA.

Важное замечание:  Для получения информации о пакетах, поддерживаемых этим выпуском, см.
раздел View пакет versions available in the Control Room.

Заметки о выпуске Automation 360 v.22
Дата выпуска: 21 September 2021

Review what's new and changed, and the fixes and limitations in the Automation 360 v.22 release. Сборка
10535 is for Cloud and Сборка 10526 is for On-Premises. For Automation 360 IQ Bot, Cloud is on Build
10535 and On-Premises is on Build 10520.

Важное замечание:  We have updated the Automation 360 Cloud build to include additional fixes for
the Apache Log4j2 component vulnerability. The build includes the new Log4j2 library version 2.16.0.

• Миграция
11.x и 10.x | Только 11.x

• Рабочая область RPA

Новые возможности |  Изменения | Исправления | Ограничения
• AARI

Новые возможности |  Изменения | Исправления | Ограничения
• Discovery Bot

Новые возможности | Исправления | Ограничения
• IQ Bot

What's new | What's changed | What's deprecated | Fixes | Limitations
• Bot Insight

Fixes | Limitations

Обновление до этого выпуска
Предусмотрена возможность обновить Automation 360 v.22 с трех предыдущих выпусков (то есть с
n-3 выпусков, где n означает последний выпуск).
Перечисленные ниже предыдущие выпуски сертифицированы для обновления до этого выпуска:
• v.21 (сборки 9664, 9642, 9595)
• v.20 (сборка 8815)
• v.19 (Builds 8147, 8145, 8122, 8098)

Вы можете напрямую обновить v.22 из любой из этих сборок. For details on how to update, see
Обновление до последней версии Automation 360.

Recommendation:  Если вы не используете выпуск n-3, перед обновлением до данного выпуска
обновите Automation 360 до одного из трех сертифицированных выпусков.
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Важное замечание:  This release includes a required update to your . Ensure that you complete the
update to continue with your automation activities when upgrading from a previous release to this release.

Автоматическое обновление Bot Agent | Обновление Bot Agent вручную

To verify which  version is compatible with this release, see Compatibility with release builds.
Для получения информации о последних обновлениях Automation 360 расширения для Google
Chrome, Microsoft Edge и Mozilla Firefox см. раздел Browser extensions for Automation 360.

Особенности миграции

Enterprise 11 and Enterprise 10 features

Migrate боты that use Credential variables (Service Cloud case ID: 00705937, 00761271,
00776189)
You can now migrate боты that use Credential variables that are not available in the Cloud Control
Room. However, you must create the required credentials after migration in the Credential Vault
and use them in the migrated боты to run these боты successfully.

Migration support for Browser, Java, and Java Applet applications for Интеграция
приложений command
You can now migrate боты that contain the Интеграция приложений command with application
types such as Browser, Java Applet, and Java applications.

New Action Required tab in Bot Scanner report
In the Bot Scanner report, we have introduced the Action Required tab within the Bots that
can be migrated now section to provide advance notification about боты that require manual
intervention after migration so that they can run successfully in Automation 360. View messages
associated with the бот that requires action to understand the cause and the specific action you
must perform in Automation 360.

Анализ отчета Bot Scanner для миграции

Action required, Review required, and Error messages for migration
Migration messages are now classified into the following categories: Action required, Review
required, and Error messages:
• Action required and Review required messages are displayed for боты that contain

unsupported commands but which you can still migrate and run after migration by performing
specific actions. The messages provide specific actions you have to perform or information that
you have to review to ensure that these боты run successfully after migration to Automation
360.

• Error messages are displayed when a specific бот is not migrated successfully. The messages
also include the cause for the failure.

Сообщения при выполнении миграции
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Только для Enterprise 11

Миграция боты с указанными ниже атрибутами.
• Боты with timeout specified in their property
• Боты that contain the GUI Automation command with the Restore Window or the Execute

Script option selected
• Боты that open a session for Эмулятор терминала and Microsoft Excel in the parent бот and

close that session in the child бот
• Боты that automate email-related tasks on Microsoft Exchange 2013
• Боты that use SAP BAPI standard and custom workflows to automate tasks on SAP applications
• Боты that contain the Окно command with the Close All Open Windows selected to close all

multiple active windows (Service cloud case ID: 00773227)

Рабочая область RPA

Новые возможности

Save bandwidth on devices through preloaded offline бот packages
Customized or most commonly used бот packages in a бот are now saved offline on a user device
to the following new folder: AAPreloadedPackages. When a бот is deployed on a user's device,
the packages are used from this AAPreloadedPackages folder instead of downloading them
from the Control Room.
When a specific version of the package is available, you can download it from the Control Room
repository to save the time required to download the package during бот execution.
Preload пакеты | Устройства

Introducing Text file пакет
A new Text file пакет is now available and includes the Get text action. Use this action to extract
text from files that have Japanese characters with Shift-JIS encoding and then save the content in
the files to a string variable.

Текстовый файл пакет

Новое actions в пакет Окно
• Use the Close all action to close all windows or programs running on the system, except the

windows added in the Add window field.
• Use the Restore action to restore the size of a maximized or a minimized window or application

running on the system.

Окно пакет

Share session across боты
Share a DLL, Excel, and Terminal Emulator session across multiple боты using the Global session
option. You can also share a session with specific child боты using the Variable option and share a
session with only the current бот using the Local session option.
Sharing sessions across боты
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Новые возможности

Enhancements to Расширенный Excel пакет
• Open files with .xml and .txt extensions using the Open action.
• Use the wildcard character (*) in the Open action for file names to search based on the

wildcard pattern.
• When you use the Run macro action and specify an argument that has a blank value, this

blank value can now be passed to the macro.

New option in Database: Disconnect action
In the Database: Disconnect action, you can now use the Keep database schema in cache
until bot finishes running option to enable the Loop action to iterate the dataset by using
cached schema after disconnecting from the database.

TNS name supported for Oracle Database connection
TNS (Transparent Network Substrate) name is now supported in the Oracle Database. You can
connect to the Oracle Database by specifying the TNS name and path of the tnsnames.ora
configuration file.

New Exchange version supported in Эл. почта пакет
In the Эл. почта пакет, when you choose an EWS server to establish a connection, you can now
use the Exchange2013 option in the Exchange Version field.

Усовершенствование AISense Recorder
AISense Recorder now enables automation of applications that use Russian and a combination of
Russian and English interfaces.
AISense для записи задач из удаленных приложений

Enhancements to recorder conditions for пакеты
• Use the new Object does not exist condition from the Condition list of any пакет to verify

whether a specific object in a window exists and then execute actions based on the result.
This condition works with SAP technology as well.

• The existing Object condition is now renamed as Object exists.

Цикл пакет

Enhanced support for Веб-служба SOAP URI (Service Cloud case ID: 00759811)
In the Веб-служба SOAP пакет, if the input to the Address location field is empty, the бот now
retrieves the address location from the WSDL file.

New option in Веб-служба SOAP пакет
Use the Build SOAP request option in the Веб-служба SOAP пакет to retrieve SOAP request
details from the SOAP URI or the WSDL file. You can now select any operations from the list of
services and ports available in the SOAP Request to automatically populate data in the fields of the
Веб-служба SOAP action.

Пример использования действия веб-службы SOAP

New option in Веб-служба REST (Service Cloud case ID: 00764198, 00800287)
In the Веб-служба REST пакет, you can now use the Allow insecure connection when using
https option to skip SSL certificate validation and to allow non-secure connections.
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Новые возможности

Relative click and occurrence supported in пакеты (Service Cloud case ID:
0055643,00754173)
When you capture a target image using the Распознавание изображений пакет, you can now use
the Preview option to select a specific captured occurrence and position your click location relative
to the image.
The feature is supported in the following пакеты and actions:
• Распознавание изображений > Find image in window
• Распознавание изображений > Find window in window
• Если > Image Recognition condition
• Цикл > While > Image Recognition condition
• Wait for condition action > Image Recognition condition

Using Find image in window action|Using the Find window in window action

Wait time option in Google Таблицы пакет (Service Cloud case ID: 00738249, 00817449,
00814775)
When you use the Connect in the action in the Google Таблицы пакет to establish a connection
with the Google server, you can now set a wait time in the Wait for actions to complete field
when performing actions such as Get, Set, or Delete. For example, if you have a large file that
takes a long time to open, you can now set the wait time for the file to open before the system
executes the next set of actions.

New option for Put action in Словарь пакет
You can now assign a static value to a key for a dictionary variable by using the Static value
option in the Put action in the Словарь пакет.
Dictionary пакет

Java applications supported in App integration пакет
The App integration пакет now supports Java applications that are based on the Standard Widget
Toolkit and Abstract Window Toolkit, which can draw text using Windows text-drawing APIs.

Use regular expressions in Файл > Open action  (Service Cloud case ID: 00737614)
Use regular expressions (regex) in the Open action of the Файл пакет to support pattern-based
search.

Specify timeout for боты (Service Cloud case ID: 00667049, 00690892, 00699158, 00706491,
00739420, 00739415, 00741590, 00769795)
You can now specify the amount of time by which the execution of a бот must be completed. The
system stops the бот execution if it is not completed within the time you specified.

Настройте время ожидания выполнения для бот
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Новые возможности

New option to search text within бот content in Bot editor (Service Cloud case
ID: 00735685, 00736201, 00739122, 00740481, 00733885, 00748970, 00746459,
00738181,00756441,00759037,00761453,00764478)
In the Bot editor, use the search box in the Flow, List, or Dual view to search for text, variables,
or actions in the entire бот content such as package name, action name, string name, or variable
name. This feature helps you to view or edit a бот with long code lines to determine where the
searched text, such as variables, strings, or actions, is used and in which line.

Действия palette for бот creation

Enhancements to the бот structure
We have enhanced the overall readability of the бот structure and updated the node labels of the
бот to show selected properties and parameters of each action in detail in the Flow, List, and Dual
views. You no longer have to expand each action to view these details.
The Flow, List, and Dual views display the following properties of actions:
• The value you enter for actions such as Set text for all supported technologies
• Names of objects on which actions such as Set text, Click, Left click, Get property, and

Select item by index are performed
• Name of the object property mentioned in the action
• Name of the return variable if some value is assigned to a variable
• List of properties for the Get property action

Enhanced network security control
As a Control Room administrator, you can now configure and audit specific, permitted URLs for
more granular control of the network access points.
Set callback URLs

Enhanced proxy support
Connections to the internet are often run through proxy servers. Automation 360 provides
enhanced support for proxy configuration for packages, such as REST and SOAP packages, for
building and running боты.

Подключение Bot Agent к устройству с использованием прокси-сервера

Connect to Azure DevOps (Cloud) Git from Control Room
You can now connect to Azure DevOps (Cloud) Git through the Control Room to check in a бот and
its dependent files to the remote Azure DevOps (Cloud) Git repository.
Connect to Azure DevOps Git from Control Room

Work item ID and time filters for workload automations
Combine the work item ID and start time of a queue to search for specific work items and monitor
the progress of these work items. The start time filters the list of all work items that start between
specified start date and start time.
Actions allowed on view queue page

© 2023 Automation Anywhere. All rights reserved.     364



    Automation Anywhere - Learn

Новые возможности

Enhancements to execution type key in AATaskExecutor variable
• When you schedule a бот to run, the Execution_Type key in the AATaskExecutor variable now

returns information about the execution type with schedule type (frequency) such as Run as
 schedule Daily, Run as schedule Weekly, or Run as schedule Monthly.

• When you use a trigger in a бот, the Execution_Type key can be accessed through the
trigger data. The Execution_Type key returns the Run through Trigger as a string for
triggers.

Language support for variable names
Variable names now support Greek and Japanese languages. You can now create variable names
using the following characters:
• Greek uppercase and lowercase characters
• Japanese Katakana full-width and half-width characters.

ML services support in Linux package installer
The python package in the Linux installer package is now updated to support ML services. When
you download and install Control Room on Linux, ML services are up and running as part of the
installation process.
Installing Control Room on Linux | Stop and start Control Room services on Linux

Direct download support in Bot Store
Users who cannot connect their Control Room to the internet can now directly download
Automation 360 боты and пакеты locally from Bot Store and then import them to their Control
Room.
Download locally and import боты and пакеты from Bot Store to Control Room

MS-SQL database management enhancement
Administrators are no longer required to re-install Automation 360 to have the ability to change MS-
SQL configuration related settings. The editable settings include username, password, database
server name, database server IP and port numbers.

Изменения

Changes to Runtime Window
The title on the Runtime Window is now changed to Bot running from the previous
Automation Anywhere.
If any issue occurs in your automation due to this title change, see this article on how to resolve it:
A360.22 | Runtime Window: Minimize Command Fails Due to Title Change (A-People login required)
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Изменения

Changes to Run DLL пакет
• The Run function (Legacy) action is no longer available in the Run DLL пакет. We

recommend that you use the Run Function action from the Run DLL пакет because this action
is an improved version of the Run function (Legacy) action.
Note that existing боты that use the Run function (Legacy) will continue to run successfully
without any issues.

• The Set session variable action is no longer available in the Run DLL пакет. Instead, we
recommend that you create a new DLL session using the Variable option in the Open action of
the Run DLL пакет.
Note that existing боты that use the Set session variable action will continue to run
successfully without any issues.

Messages for migrated боты for which referenced MetaBot logic is not available
Bot Scanner and Migration Assistant now display action required messages for Enterprise 11 or
Enterprise 10 боты for which the referenced MetaBot logic is not available.

Migration of боты with missing variable is blocked
The migration process does not migrate Enterprise 11 боты that use a variable which is no longer
available and that variable is used in the Если, Цикл, Операция переменной, or Буфер обмена
command. Previously, these боты were successfully migrated but an error occurred when the боты
were run.

Update to MetaBots that use same DLL in multiple logic (Service Cloud case ID: 00684185,
00730248, 00742840, 00742840, 00779629, 00779788, 00727977, 00743986, 00764872)
Migrated боты that use the same DLL in multiple MetaBot logic now work as expected without any
modification. Previously, you had to update the migrated боты to run them successfully.

Migrated боты run successfully when mapped variables are not available (Service Cloud
case ID: 00746651, 00785703)
Migrated боты now run successfully when mapped variables are not available in the child бот or the
parent бот.

Enhancements to Bot Agent device settings
To easily access local and remote devices, a user can now change the Bot Agent device settings
from the My Settings page in the Control Room pane below your username. Вы можете
выполнить указанные ниже действия.
• Обновить учетные данные устройства
• Change the default Bot Runner device
• View local device name, status, and Bot Agent version

Set user device credentials | View and update Bot Agent device settings

Enhancement to auto discovery for multiple domains
You can now configure the maximum number of sites that can be discovered across the domain in
the um.properties file for a Control Room set up for auto discovery across multiple domains in
different locations.
Configure Control Room for Active Directory: auto mode
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Изменения

Enhancement to OpenDistro for Elasticsearch
As part of enhanced security, OpenDistro (cron-utils) is now upgraded to v.1.13.2 for Elasticsearch
v.7.10.2

Update to Printer пакет
In the Remove and Set default actions of the Printer пакет, you can now select a specific printer
from the list of available printers.

Принтер пакет

Insert recorded actions in the middle of a бот
You can now insert any recorded actions that are newly captured at a specified location in an
existing бот. Previously, recorded actions were added to the existing бот at the end by default and
users had to drag the action to the specified location.
Universal Recorder for object-based automation

Migration: system variable behavior outside a loop (Service Cloud case ID: 00761281)
When you migrate боты that use system variables outside a Цикл пакет, the variables are now
converted to record type or string type user-defined variables as applicable and assigned to a
record action. As a result, when боты that contain these variables are run, data from the last row is
displayed. Previously, an empty value was displayed after migration.
The following system variables are converted to record type variables:
• $Filedata Column$
• $Excel Column$
• $Dataset Column$
• $Table Column$

The system variable $XML Data Node$ is converted to a string type variable.

Сопоставление переменных для миграции

Support removed for Redirect URI attribute in Google Таблицы пакет (Service Cloud case
ID: 00777287)
The Redirect URI attribute in the Connect action of the Google Sheets пакет is now removed.
After updating to this release from previous Automation 360 releases, you can continue to
successfully execute your боты by entering the fixed redirect URL in Google Cloud Platform:
http://localhost:8888/Callback

Updates to device credentials recorded in audit log (Service Cloud case ID: 00691511)
You can now view audit log entries if your device credential is updated either manually through the
Bot Agent device or through the Control Room API. Activity details such as the user name updating
the device credentials and the time of the update are logged.

Усовершенствование пакет Распознавание изображений
When secure recording is enabled, the target image that is captured using the actions in the
Распознавание изображений пакет is now hidden after the initial capture to enhance security.
Previously, the user was able to view the target image even when secure recording was enabled.
Image Recognition пакет
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Усовершенствование пакет Файл и папка
Users with a valid role permission can now create a shortcut to a selected source file at a specified
location using the Create shortcut action in the Файл и папка пакет.

Support for HTTP method HEAD (Service Cloud case ID: 00754096)
The HTTP method HEAD is now supported as an API call to connect to the load balancer of a
Control Room configured for high availability.

Update to Linux installation and log path
• Installation files

• If you are on a version earlier than Automation 360 v.22 or if you have updated from
an earlier version to v.22, the installation files are now stored in this path /opt/
automationanywhere/enterprise

• If you perform a new installation of v.22, the files are stored in this path: /opt/
automationanywhere/automation360

• Log files
• If you are on a version earlier to v.22 or if have updated to v.22 from an earlier version, the

log files are stored in this path: /var/log/automationanywhere/enterprise
• If you perform a new installation of v.22, the log files are stored in this path: /var/log/

automationanywhere/automation360

Check out a TaskBot with specific version
If a бот has multiple versions, you can now select and check out the specific version of the бот. As
a Bot Creator, this enables you to roll back to an earlier version of the бот.

Signed DLLs for боты and пакеты
Automation 360 now signs all DLLs, including third-party DLLs, for боты and пакеты.
The following are exceptions:
• The IQ Bot Pre-processor пакет does not have a new version in this Automation 360 v.22

release. The v.21 package version is copied to v.22 without modification, including a few
unsigned DLLs.

• The Process Discovery пакет in this v.22 release does not have the signing applied.
• Automation Anywhere
• Azul Systems (Java JRE in Bot Agent)
• TeamDev Ltd. (third-party library)

Исправления

ID обращения к
облачному сервису

Описание

00712808, 00765752 In previous releases, Automation Anywhere related files were
sometimes generated in C:\Windows\Temp. This issue is now fixed.

00800392 An error no longer occurs when you migrate from a Enterprise 11
version where a database is stored on Google Cloud Platform.
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ID обращения к
облачному сервису

Описание

00811887 The Cloud Migration Utility no longer encounters an error when you
use a custom port number to connect to the Enterprise 11 database.

00815097 Enterprise 11 боты that are checked out by a user are now
successfully migrated to Automation 360 Cloud.

00802360 You can now update the value of Enterprise 11 credential attributes
after they are migrated to Automation 360 Cloud. Previously, the
system encountered an error when you updated the value of a
credential attribute that was added or updated by a user in Enterprise
11 and that user was no longer available when Enterprise 11 data was
migrated to Automation 360 Cloud.

-- When you migrate from Enterprise 11 to Automation 360 Cloud, an
error no longer occurs when a locker is deleted in Enterprise 11 but its
related permissions are still used in other entities.

-- An error no longer occurs when you update from Version 11.3.5.2 to
any Enterprise 11 version and then migrate from that Enterprise 11
version to Automation 360 Cloud.

-- The Refresh and Back options are now available on the Summary
screen of the Cloud Migration Utility when enough disk space is not
available to store the backup of Enterprise 11 Control Room data.

00787240, 00781349 Migrated боты no longer encounter an error when a parent бот and
its child бот are opened through Internet Explorer and the child бот
extracts a table from Internet Explorer.

-- There is no limitation now on the number of ActiveMQ connections
that are allowed when running an automation that is looped 5 times,
with each loop running over 20 боты. In previous releases, the
automation sometimes failed after the fourth loop.

0074312 You can now successfully migrate боты that contain Trim operation of
the String and the output is assigned to an Array variable.

00760963 Migrated боты that contain the Go To Cell command now work
properly in Automation 360 after migration.

-- Bot Scanner now loads the modified cache.properties file
from the conf folder. Previously, you had to place the modified
cache.properties file in the executable file location of the Bot
Scanner for the file to be loaded.

00754003 Боты that contain the Веб-служба SOAP command now successfully
run after migration without encountering any error. Previously, an
unexpected error occurred when the Веб-служба SOAP with WSDLs
defined with external dependencies were not invoked.

00790360 In the Terminal Emulator пакет, when you send any key to the
terminal with the Send text or Send key action, if the terminal is in
a busy state or the keyboard is in a locked state, these actions now
wait for 5 seconds for the terminal to return to a normal state. After
5 seconds, the system moves to execute the next action without any
exception.
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ID обращения к
облачному сервису

Описание

00742000 Migrated боты that contain the Prompt > For value command
with the Don't write in any windows option selected now work
as expected in Automation 360 after migration and no text is written
in the file if any window is open. Previously, even if this option was
selected, if any text file window was open, the text was written in the
file.

00781072 When боты are migrated using the Bot Migration Wizard, migration no
longer fails if the бот name includes a special character. Previously, an
internal error occurred when the бот name included an apostrophe (')
character.

00780713, 00778164 A migrated бот is no longer unresponsive when that бот uses the
Интеграция приложений пакет to capture text from a target
application and the target application becomes unresponsive.

-- Migrated Enterprise 11 боты that use the Эмулятор терминала
command to clear the terminal screen of the VT and ANSI type
terminals no longer encounter an error when they are executed.

00748647 Migrated Enterprise 11 боты that use two-dimensional array and
the Операция переменной command no longer encounter an error.
Previously, the migration process used to set the number of rows and
columns for the two-dimensional array to 1x1 irrespective of the values
set in Enterprise 11.

-- The migration process continues to migrate боты if the connection
between the Control Room and the Bot Agent is lost and then
reestablished. Previously, the migration process failed when the
connection between the Control Room and the Bot Agent was lost.

00764441 In the Excel: Get single cell action of the Excel advanced пакет,
you can now access the value of a specific cell defined in the cell
address. Previously, migrated боты encountered a Must match
pattern error when a Japanese character was entered in the Cell
address field.

00757713, 00764985,
00820376

The Excel advanced пакет now enables you to read from a
protected sheet. Previously, migrated боты encountered an error
when you retrieved a cell from a protected sheet using the Excel
advanced: Open action.

00761911 You can now migrate боты using the Excel column system
variable where the key is the column name; an error is no longer
encountered.

00769321 Migrated боты no longer encounter an error when the Run Excel
Macro command is included in the боты. Migrated боты now run
properly using the Run macro action of the Excel advanced пакет.

00790858 You can now migrate a бот when there is a variable mismatch
and the respective command is disabled. Previously, when the бот
was assigned a certain variable type and the Variable Operation
command in that variable was disabled, Bot Scanner displayed an error
for the variable when the type was later changed.
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ID обращения к
облачному сервису

Описание

00744318, 00744326,
00745318

You can now download an exported бот file with Japanese characters
in the filename through email. Previously, when an exported file with
a Japanese name was downloaded using the email link, an error
occurred or the characters in the exported zip filename were garbled
and .zip was appended to the filename.

00762975 After you migrate Enterprise 11 боты that use the Error handling
command with the Send email function and the Attach variable
and Attach snapshot option, the боты now correctly send error
emails with attachments containing a snapshot or variable text file.

00731577, 00746226,
00760649, 00759973,
00767618, 00789545,
00821824

The includePackages parameter of the Export API now works as
expected. If you set the value of the parameter as True the packages
are included in the exported file, and if the value is set to False the
packages are not included in the exported file.

-- You can now migrate боты with variable names that include full-
width and lowercase characters. Previously, migration of боты with a
variable name that included full-width and uppercase characters was
not supported because the variable was mistakenly converted to a
half-width character.

00759189 Migrated боты now use the date format specified in the
AADefaultDateFormat global value for email-related automation. You
must create the AADefaultDateFormat global value before migrating
the боты and specify the date format you want to use in the migrated
боты.
Рекомендации: Specify the same date format in the
AADefaultDateFormat global value that is used in Enterprise 11.

00784001 Enterprise 11 боты that are migrated now contain all the properties of
an object captured from a SAP application.

00786362, 00802274 Enterprise 11 боты that are migrated no longer encounter an error
when the child бот and parent бот use different versions of the Если
пакет.

00807986 Enterprise 11 боты that are migrated no longer encounter an error
when a variable that is mapped between a child бот and the parent
бот is not available in the child бот.

00808026 Enterprise 11 боты that are migrated no longer encounter an error
when they use a shared session for Эмулятор терминала related
tasks when a session is shared between nested child боты and an
intermediate child бот does not contain any Эмулятор терминала
actions.
For example, consider that you have three боты: Bot1, Bot2, and Bot3,
where Bot1 calls Bot2 and Bot2 calls Bot3. Bot1 and Bot3 share a
session for Эмулятор терминала related tasks; however, Bot2 does
not contain any actions from the Эмулятор терминала пакет. When
you share a session between Bot1 and Bot3, an error is no longer
encountered.
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ID обращения к
облачному сервису

Описание

00762368 Previously, when боты were migrated using Oracle database processes
with passwords containing the symbol, an issue occurred. The issue is
now fixed and passwords using the “@” symbol are now supported.

00768466, 00769099 An error no longer occurs when you migrate MetaBots that contain
logic that are available within a folder.

00772885 The system now retrieves all rows in a table in a SAP application when
the last page of the table contains a single row.

00801733 An increase in CPU usage no longer occurs when the Control Room is
in an idle state.

00774821 An error no longer occurs when you run migrated боты that contain a
Цикл action within another Цикл action.

00786732 For Enterprise 11 боты that use the Extract Table command along
with other commands within the Обработка ошибок command and
only the Extract Table command is disabled, only the equivalent
action for the Extract Table command is disabled after migration.
Previously, all the actions within the Обработка ошибок action were
disabled in the migrated бот.

00743892 An error no longer occurs when you run migrated боты that use DLLs
that return a value of user-defined type. Such values are converted to
the string type in the migrated боты.

-- Enterprise 11 боты that use variable operations to re-initialize an
array type variable to contain more than 160,000 cells (for example,
400 rows and 400 columns, or 800 rows and 200 columns) no longer
encounter an error when they are executed after migration.

00737025 Enterprise 11 боты that pass system variables such as Month, Year,
and Day as an input variable to a MetaBot no longer encounter an
issue after they are migrated.

00773407 Previously, historical activity reports exported to CSV did not display
the Last Modified information correctly because some of the
Modified On and Modified By information was not accurately
processed. The error is now fixed and historical activity reports can
now be correctly exported to CSV files.

00767597 The Last Modified (date) value displayed in the historical activity and
бот page reporting was previously not translated correctly when the
Control Room language was changed from English to non-English, and
then back to English. This error is now fixed, and the data is preserved
when the language is changed in the Control Room.

00762975 Japanese language text is now updated in the interface for recent user
experience (UX) changes. Previously, there were some errors in the
translated text in the interface, which are now fixed.

00763228, 00776154 Database constraints, such as foreign key constraint violations,
previously prevented users from deleting боты after migration. This
limitation is now fixed and users can delete migrated боты (.atmx
files) without any issue.
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00749375,00763262 After migration, if text file encoding was set to UNICODE or UTF8,
you can now use the String: Import string from text file key to
read values from the text file during бот runtime.

00739268 You can now migrate боты that have large html data associated with
the Object Cloning command without any issues.

00674147, 00682390 The Stop service action of the Service пакет now enables you
to stop all child and dependent services of a selected window
or application. Previously, the dependent service did not stop
automatically when a user tried to stop any window or application
service.

00754835 Temporary devices are now automatically deleted if the auto-delete
option is enabled for device settings in the Control Room.

00751058, 00761099 When you use the База данных Connect action for workload
automation, work items from the second iteration are now executed
for automation. Previously, only the first work item in the workload
automation was executed.

00771098 After you edit a schedule from the Scheduled activity page and save
the schedule, the correct page (Scheduled activity) is now opened
instead of the In progress activity page.

00733614, 00741358 You can now use the Extract image action of the PDF пакет to
convert a PDF file that contains JPX images to any other image format.
Previously, the action failed to extract image from the PDF file because
the JPX image reader was not supported.

00765851 Средство записи actions now work properly and do not cause any
delay when the Set text value contains brackets or [] (which enables
you to run a migrated бот without delay). Previously, it took a longer
time to run the бот when Set text contained [] (brackets).

00771197 In the Open action of the Браузер пакет, the description below
the Time out after (seconds) (optional) field is now translated
correctly as Min= 9 seconds in the Japanese language. Previously,
the description was translated as Max= 9 seconds.

00761395 In the База данных пакет, when you connect with the Oracle
Database and use the Read from action option in a loop to retrieve
records from the database, the бот is now executed successfully.
Previously, бот execution failed with an error.

00727530 The Move all action in the Эл. почта пакет now works properly and
does not encounter any issue.

00739978 An error no longer occurs when you choose the Manual input option
to open a VB Script file.

00728180 The issue with event triggers when creating folders in bulk is now
resolved. If you configure an event trigger to start a бот whenever
a folder is created and then create folders in bulk, the бот is now
deployed for every folder that you create. Previously, the бот was not
deployed for all the folders created.
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00711134, 00750164,
00847916

If you configure multiple triggers to start боты based on file events
and if all the files reside in the same folder, the боты associated with
all the triggers are now deployed. Previously, only some боты were
deployed.

00719612 When you log in to the Control Room as an unattended Bot Runner,
you can now execute боты using the Run as self option. Previously,
an unattended Bot Runner could not run the бот with the Run as self
option even when the device was set as the default device.

00745095 In the База данных пакет, when you connect to the Microsoft Access
database using the JDBC connection, the select query now extracts
the file name for the Attachment data type. Previously, an error was
displayed.

00772194 Data from any database type is now exported correctly in CSV format.
Previously, if the data had special characters such as double quotation
marks, the output was displayed in a new line.

00773961 When you create a new worksheet by name in the Google Таблицы
пакет, an error no longer occurs when you execute the бот.

00762029 An error no longer occurs when you execute a бот using the Google
Календарь пакет. Previously, when the Disconnect action was used
to terminate the connection, the email address attribute was stored
in the session name instead of the user session name attribute. As a
result, бот execution failed with an error.

00758333 If all versions of a particular пакет are disabled, then the пакет is no
longer listed in the Actions palette of the Bot editor.
Previously, when a package was disabled, the Bot Creator still
displayed it in the Actions palette and users were able to use the
package when creating a бот. However, these боты failed on execution
because the пакет was disabled.

00780221 A бот created using the Run function action in the Run DLL package
now executes without any issues. Previously, an error was displayed on
бот execution due to the unavailability of some embedded resources
such as satellite assembly.

-- An error no longer occurs when you create a бот using the Send text
action of the Эмулятор терминала пакет and pass a variable with an
empty value. Previously, the бот failed to execute when any variable
options (Credential, Variable, Insecure String) that had no value was
selected.

00776430 When you connect to the Terminal type TN3270E in the Эмулятор
терминала пакет, select any of the Terminal model options from
the list, and execute the бот, the correct screen resolution is now
displayed. Previously, a wrong value was sent for each Terminal model
and a screen with incorrect resolution was displayed.
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00773415, 00781487 When you open a spreadsheet in the Google Таблицы пакет and
select the Beginning of the row option in the Go to cell action, the
output is now displayed correctly. Previously, the output was displayed
at the column level.

00773415, 00781493 An error no longer occurs when you open a new or blank spreadsheet
in the Google Таблицы пакет and you select an action such as Go
to cell or Set cell to perform an operation. Previously, бот execution
failed with an error.

00779561 In the Система пакет, when you use the Get environment
variable action in view mode, the environment variables are now
always displayed in the list. Use the refresh option to retrieve all the
environment variables in the list. Previously, the environment variables
were sometimes not displayed in the list.

00775073 In the Расширенный Excel пакет Get worksheet as data table
> Read option, the description for the Read cell value option now
reads correctly as 50% will be read as 50 when it is translated
to the Japanese language. Previously, the description was translated as
50% will be read as 50%.

00767246 The Веб-служба SOAP пакет now works for URIs, where the service
endpoint can be passed as a URI parameter. Previously, an error was
displayed for such requests.

00734463, 00754570,
00766456

When the Connect action of the База данных пакет is used to
establish a connection with the Microsoft SQL Server using Windows
authentication, the бот now executes successfully even when the
parent and child боты use different versions of the База данных
пакет.
Previously, the бот failed if the parent and child боты used different
versions of the База данных пакет.

00780921 An error no longer occurs when you use the PDF extract text action
to extract text from a PDF file. Previously, when structured text was
extracted from a PDF file, an error was displayed because the index
exceeded the 1000 range.

-- In the Расширенный Excel пакет, when you use the same session
name to open multiple Excel spreadsheets, the бот now displays an
error on execution. Previously, if the same session name was used in
multiple spreadsheets, the бот overwrote the existing open session
when the second Open action was executed.

00785198 In the Таблица данных пакет, when you now use the Write to file
action to extract data from a table with large records, 1000 rows of
data are read in batches and written to a CSV file.
Previously, a Java heap space error was displayed because the
configured Java heap memory ran out of space. As a result, data could
not be retrieved from a table with large data and written to a CSV file.
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00757593 In a Cloud deployment, child боты can now be migrated using the
Migrate Бот action from the Бот Migration package. Previously, child
боты were not migrated but a migration successful message was
displayed.

00731012, 00747385,
00746320

If you install the Control Room in the default location in C:\ and
configure the logs directory in another location (for example, E:\),
WebCr logs are now generated dynamically in the custom location.

00768318, 00760835 An error no longer occurs when you try to capture objects using
AISense Recorder on any version of Windows that does not have the
default media feature pack. Previously, the AISense Recorder did not
highlight the objects on a page.

00737710 In the Capture action of the Средство записи пакет, when you select
the Set Text action and enter a string variable with a delay set for
each keystroke, the output is now displayed correctly on a new line for
all Microsoft applications. Previously, on бот execution, the output was
shown on one line when a delay was set in the Keystroke.

-- Если вы развертываете боты с помощью триггеров событий
и устанавливаете Bot Agent на устройстве в качестве
пользователя без прав администратора для себя или локального
администратора, параметр Bot Agent теперь обновляется
автоматически. Устройство больше не отображается в Control
Room как отключенное.

00782596 You can now migrate workload automation боты from Enterprise
11 to this release. A client protocol exception message is no longer
displayed.

00743810, 00785703 You can now map variables with different letter cases between
parent and child боты when you run боты after migrating them from
Enterprise 11 to this release. For example, if the variable name in
Enterprise 11 is Var1 and the variable name is changed to var1 after
migration, you can map the variables and continue to run the боты.

-- Бот deployments on Bot Agent devices no longer fail when you close a
terminal window using the close Окно action from the Окно package
or manually close the Эмулятор терминала window.

00767587 You can now run боты from the In progress activity page.
Previously, боты were stuck in the Pending execution state and as
a result other боты did not run. You had to manually move the боты
stuck in this state to the Historical activity page to run the other
queued боты.

00789682, 00798933 You can now delete, reset, or place on hold workload automations
because work items are no longer stuck in the ready to run status.
Also, the following message is no longer displayed: Work item
cannot be deleted in this state.
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Исправления

ID обращения к
облачному сервису

Описание

00720471 An error no longer occurs when you use the Средство записи package
to capture an object and perform the click action on the capture
coordinates. Previously, when you captured the object properties and if
the download bar in Google Chrome was open, object properties in the
browser could not be captured.

00754651 In the If action of the If пакет, when you select any condition from
the Condition list, and drag any other action inside the If action, the
condition is no longer deleted from the Condition list and the action
no longer disappears from the List and Flow view.

00768354 An error no longer occurs when you use the AISense Recorder in child
боты when running them in a loop. Previously, when the AISense
Recorder was used in a child бот and the бот was executed, external
processes were not terminated, causing the system to run out of
memory.

-- Previously, when бот migration was performed, the process sent
various, occasionally multiple, email notifications to all existing
Control Room users, even if the administrator had disabled email
notifications. An option is now added to enable the administrator to
disable email notifications when Credential Vault data is created during
бот migration.

00762368 Previously, when боты were migrated using Oracle Database processes
with passwords containing the “@” symbol, an issue occurred. The
issue is now fixed and passwords using the “@” symbol are now
supported.

-- Previously, during migration, a parent бот was successfully processed
even if associated child боты did not exist. This created errors during
runtime. In this release, if associated child боты do not exist for the
parent бот, a message notifies the user of the required action before
migration can continue.

00762975 Боты that used the Обработка ошибок action to capture screenshots
were incorrectly modified and appended as .PNG files. Migrated боты
are no longer modified and appended in this manner.

00751496 Attended Bot Runner devices now show an improved time performance
when running боты on Microsoft Edge browser.

00753673 When you run a migrated бот that contains the Excel Advanced >
Delete cell > Specific cell option with comma-separated input cell
values such as A1, B1, the migrated бот now runs successfully and
displays the output correctly.

00736473 Fixed an issue where a migrated бот containing the Excel Advanced
> Open action did not load the Excel add-ins even when the Load
Add-ins check box was selected. Now, the Excel add-ins are loaded
successfully.

00767917 You can now run боты with a queue on single user devices that were
previously configured for multiple users.
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Исправления

ID обращения к
облачному сервису

Описание

00712719 An error no longer occurs when you run боты that contain actions
from the Эмулятор терминала package on your device. Previously,
боты could not be run due to a synchronization issue with the
terminal.

00753121 An error no longer occurs when you use the Convert excel to PDF
action of the Расширенный Excel пакет to save a converted PDF to a
shared network drive.

00763746, 00773924 When you select the Keystrokes action in the Имитация нажатия
клавиш пакет and enter a variable or static text containing half-width
Japanese characters, the output now displays the correct Japanese
characters. Previously, on бот execution, the output displayed incorrect
characters.

00774872, 00807106,
00824486

When you use the Close action of the Браузер пакет to close the
last Chrome browser window, the last tab of a Chrome browser
window, or all Chrome browsers, the бот no longer encounters an
error. Previously, when the Close action was used to close the last
Chrome browser window, the last tab of a Chrome browser window,
or all Chrome browsers, бот execution failed because the Chrome
communication channel was shut down.

00762178 When you deploy боты using RDP on unattended user devices
configured for multiple users, a black screenshot is no longer captured.

00800573, 00796393,
00804854

When you select a run-as user to deploy a бот, you can add a Bot
Runner user back from the list of Selected Bot Runner to the list of
available Bot Runner on the Run bot now page.

00744929 When incorrect Git credentials are entered, the credentials are now
hidden and not recorded in the WebCR_Commons.log file. Previously,
incorrect Git login credentials were recorded and not hidden in the log
file.

00751304 The error model in Swagger docs is now updated to display all the
fields appearing in the API response body. Previously, there was a
mismatch between the fields displayed in the API response body and
the error model in Swagger docs.

00763398 An error no longer occurs when multiple Excel files are opened and
you use the Run macro action in the Расширенный Excel пакет.
Previously, an error was displayed when a macro was run with multiple
sessions.

00759183 The Open action of the Файл пакет now opens any file using the
default application set by the user. For example, if Microsoft Paint is
set as the default application for all .jpg files, the action now opens
these files without any error. Previously, бот execution failed with an
error.
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Исправления

ID обращения к
облачному сервису

Описание

00750185 An error no longer occurs when you run a migrated Enterprise 11
бот containing the Object Cloning command even if it contains some
Unicode 8964 characters in some of its properties. The бот now
captures objects after migration without any error. Previously, the
бот failed to capture objects after migration if it contained Unicode
characters in its properties.

00774091 All object properties of the Object Cloning command are now migrated
without any errors. Previously, бот execution failed with an error
because the HTML ID and HTML name properties were changed after
migration.

00796322, 00823082 When you insert a variable as a parameter in any action of a пакет,
add additional text to this variable, save the бот, and then edit the
name of the variable from the variable list, the additional characters
added to the variable are no longer deleted.

00731066 The Capture action in the Recorder пакет now works properly, and
you no longer encounter any delay when creating and running new
боты to extract any data from a DataGridView control in certain UI
automation applications.

00784177 A бот deployment error is no longer displayed when you edit and run a
бот using Run bot now from the Bot editor of a Cloud Control Room.

00782307, 00787807,
00811404, 00788178

Бот deployments are no longer stuck in a queue and now display the
error Picked at runtime after Automation 360 On-Premises is
updated from the previous release to this release.

00786786, 00806775 You can now capture a single object using a recorder from Google
Chrome browser, and the following message is no longer displayed:
Error performing single capture.

00780202, 00798826,
00808779

When you deploy боты using RDP on unattended user devices
configured for multiple users and you set the RDP screen resolution to
1366x768, the resolution no longer changes to 1368x768 during бот
execution.

00769647, 00767674,
00773115, 00777239,
00778972, 00777752,
00792839, 00804603,
00806606, 00815687,
00829496

The View historical activity page now shows the correct run details
of start date and time for боты that fail during execution.
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Ограничения

При настройке внешнего хранилища ключей в разделе Интеграция внешнего хранилища
ключей и выборе режима Проверка подлинности SQL для аутентификации базы данных
на странице Сервер базы данных установщика Windows с целью установки Control Room
(On-Premises) происходит сбой установки и отображается указанное ниже сообщение об
ошибке. Сбой при создании таблиц базы данных Control Room.
Обходное решение. Добавьте учетные данные базы данных во внешнее хранилище ключей
и используйте их для настройки базы данных.

The Task bots runs metric on the Home dashboard page of the Control Room displays the count
as zero even if you have run боты from the same Control Room.

(ID обращения к облачному сервису: 00837271) Если вы выполняете миграцию с Enterprise
11 при использовании базы данных, содержащей большое количество данных репозитория,
установка может завершиться неудачей. Эта проблема возникает из-за того, что во время
миграции обновление Liquibase для нескольких SQL-запросов не выполнено.
Обходное решение. Обратитесь в поддержку Automation Anywhere.

When you are installing the Bot Agent, if you run out of disk space and click OK on the Out of
disk space window, the Bot Agent installation wizard might display the previous installer windows.
Обходное решение. In the Setup type window, click Cancel and relaunch the Bot Agent
installation wizard.

(ID обращения к облачному сервису: 01021889) In this release, when you schedule or deploy a
бот from the Control Room, you will not receive an email notification if the бот fails to run.

(ID обращения к облачному сервису: 00780635, 00791587, 00795559, 00795632, 00797130,
00797113, 00791783, 00765770, 00826805, 01859661) When you update from the previous
release, schedules disappear from Control Room instances configured on a single-node or multi-
node environment. In some cases, after the update, previously deactivated schedules disappear
and are reactivated automatically.
Обходное решение. Divide large schedules into smaller schedules or reduce the schedule
frequency.
• Divide large scheduled automations into smaller schedules of two hours each. For example,

divide an automation schedule that runs for a 12-hour period, such as 9 AM to 9 PM daily, into
two-hour intervals, such as 9 AM to 10:59 AM, 11:00 AM to 12:59 PM, and 1:00 PM to 2:59 PM.

• Reduce the schedule frequency to 10 minutes.

Migration of Enterprise 10 MetaBots with the password type variable with null value is not yet
supported. To migrate successfully, provide a default value to the password variable when creating
MetaBots in Enterprise 10.

When you attempt to log in to the Control Room configured with Active Directory, using the Log in
with Windows option is not currently supported in this release. Selecting this option can generate
a java.lang.NoSuchMethodError error.
Рекомендации: Enter the domain credentials directly.

(ID обращения к облачному сервису: 00831886) As a Bot Creator, you cannot run бот tasks
through the AARI process. Although human tasks appear fine, the Activity page displays the In
Progress state and seems stuck on the Waiting for user and/or device action.
Обходное решение. Remove the process discovery license - recorder from the AARI Bot
Creator user. Please refer to AARI process discovery license assignment for more information.
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Ограничения

You cannot use the Global session option to share a Microsoft Excel session using the
Расширенный Excel пакет with the Цикл пакет.
Alternate solution: Use the Get multiple cells action and save the data into a datatable
variable. Then, use the Цикл пакет with the Data Table option selected.

The migration process successfully migrates боты that contain brackets or [] but the process fails
when you migrate the same боты again to migrate the delta changes even when the overwrite
option is selected.
Обходное решение. Delete existing боты from Automation 360 that contain brackets or []
before migrating them again.

Users with the AAE_Bot Migration Admin role are not able to run migrated боты because the
Run my bots and Create folders permissions are not available in this role. As a result, these
users can start the migration process, convert the боты but cannot run the migrated боты.
Обходное решение. Create a custom role with the Run my bots and Create folders
permissions and assign this role to the users with the AAE_Bot Migration Admin role.

When Enterprise 11 MetaBots that use a DLL that returns a two-dimensional array of type single as
output and stores the value to a file using the Записать в файл command are migrated as TaskBots
to Automation 360, these TaskBots encounter an error when they are executed.

Migrated боты that are used to automate tasks using RDP encounter an error when the DPI of the
remote device is different from the current device.

Недавно созданные пользователи Control Room в Windows для виртуальных машин Google
Cloud Platform On-Premises не могут изменить свой пароль. Параметр контрольных вопросов
недоступен на экране Изменить пароль, и в результате при попытке сохранить пароль
Control Room отображает ошибку.
Обходное решение. Обновите страницу и измените пароль еще раз.

(ID обращения к облачному сервису: 00770816) When you connect to an Exchange Web Services
server, multi-factor authentication (MFA) must be disabled, including in all organizational level
security policies where multi-factor authentication might be enabled. If multi-factor authentication is
not disabled completely, users might encounter connection and or authorization errors.

Automation 360 does not support the Kibana version in Elasticsearch for which a privilege
escalation error is shown in the Black Duck report.

The Bot Agent is not updated automatically from a previous release to this release when you
perform different operations simultaneously such as running боты, configuring device settings in
the Control Room, and updating the Control Room.
Обходное решение. Restart the Bot Agent from the Task Manager.
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Ограничения

A file is not deleted when you execute the бот with the following sequence of actions:
1. You use the CSV/TXT > Open action to open a .csv file.
2. You use a loop action within another loop action to retrieve values from the .csv file.
3. You use the CSV/TXT > Close action to close the file.

Here, all the actions are using the same Default session.
4. You use the File > Delete action to delete the file.

The issue (file is not deleted) occurs because the бот fails to close the Default session.

Бот execution can fail with an error when you execute the бот with the following sequence of
actions inside a loop:
1. You use the Browser > Open action to open a window.
2. You use the Recorder > Capture action to capture required objects on the window.
3. You use the Browser > Close action to close the window.

Обходное решение. Use the Window > Close action to close the window instead.

If you update the device information from the Administration > Settings > Devices page,
only the first update is captured in the Audit Log page. Subsequent updates to the device are not
captured.

When you register a new Bot Agent user device from the бот editor after creating and running a
бот, the following message is intermittently displayed: Device is either disconnected or
it needs to be upgraded.
Обходное решение. Click Run to deploy the бот on the new Bot Agent user device.

When you use the Universal Recorder to record multiple tabs in a SAP application, the Set text
action in the Client control of SAP does not work because it is currently not supported.

When multiple users check in their bots simultaneously, some of the check-ins fail although Git is
not corrupted and no data is lost.

When you use the 2.3.0-20210806-215200 version of the Средство записи пакет to capture any
control using HTML technology in Google Chrome or Microsoft Edge Chromium browser and run the
бот, the bot might fail with the following error message: Unable to find control.Условия
поиска не совпадают

Обходное решение. Use the 2.2.0-20210722-211132 version of the Средство записи пакет
instead.

When you try to automate any process in a Java application that is using version 11.0.8 of
AdoptOpenJDK, the Средство записи might not be able to capture the drop-down elements on the
application.
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AARI (Automation Anywhere Robotic Interface)

Новые возможности

Output variables support in Process Editor
The Output variables section in the process editor enables you to create a user-defined variable
that can be set as an output to any process. This helps you pass the output from the child (sub)
process, which was called in the Process Task, to the parent (main) process.
Use an Output variable

Select File element input supported for Create a Request action
The Create a Request action in the AARI Web package now supports passing input in the request
creation forms for the Select File element. You can now use боты to create a request and upload
or download files as input with the Select File element. These input files are uploaded to the
storage service to be available for further processing in the request.

Detail view in Tasks page
The new Detail view option in the Tasks page provides better insight into individual tasks for
better task management. The detail view previews each task in its respective request view page
without opening another page, which helps organize and correspond your tasks with the available
requests. Users can interact with their tasks as well.

Additional support for interface triggers on Google Chrome
You can use the following additional actions for interface triggers on the Google Chrome browser
during бот runtime:
• Hyperlink element: Click, Set focus, or Lost focus actions
• Checkbox element: Select, cleared, Set focus, Lost focus, or Selection changed actions
• Radio Button element: Select, deselect, Set focus, Lost focus, or Selection changed

actions

Add an interface trigger

Изменения

Font size retained during бот runtime
When you create a form, the font size that you selected in the Formatting > Font size drop-
down menu is retained on the form during бот runtime.

Cancel option in the process and team setup page
When a user edits a process or team in the Process setup and Process setup pages, the Cancel
option replaces the previous X option to provide better clarity for the user to cancel the current
page.

Исправления

ID обращения к
облачному сервису

Описание

00781358 You can now add боты with table variables that do not have a default
value to a process without encountering any errors.
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Исправления

ID обращения к
облачному сервису

Описание

00791703 When you the use the desktop tray icon to open AARI Assistant,
dependent files are no longer displayed along with the application.

-- In the process editor, the Go To option now shows the Filter Task
and Process Task options.

-- When you enter data in a form of your process that contains a
hyperlink, the process data is no longer ignored and now works
correctly.

-- When you use Process Task in the process editor, you can now use
the Public folder option in the Select process file field.

-- In Bot Task and Human Task, when you select a box, the input is
now accurately selected.

-- The Requests page is now correctly updated with the latest request
events (such as completion of tasks) for users with an Attended
license.

-- When you update to this release, a built-in scheduler now periodically
checks for any disconnected or temporary devices and clears these
entries.

-- When you open a form in the public folder, it cannot now be edited by
changing the term View to Edit in the URL.

-- When a user logs in to AARI Assistant, all the triggers associated with
that user name are now available.

Ограничения

Users cannot edit a form or process in a public workspace, they must check out a form or process
in order to edit in a private workspace. However, when users attempt to edit a form or process in
a private workspace, they receive an Access denied error message due to the cache not being
refreshed.
Обходное решение. Navigate to the your private workspace, refresh the page to clear the
cache, then edit your form or process.

An AARI user with the AAE_Robotic Interface User license who is not apart of an assigned team
can view all requests and tasks from other teams in the web interface. However, when the user
attempts to access a request or task, they are prompted with an error message.

When a form is opened during бот runtime, the automated focus on the first form element is lost.
For example, consider that Form A has various elements, and a Text Box element called Name is
the first one. When Form A is opened during бот runtime, the focus is lost from the Name element
and you cannot enter any values.
Обходное решение. When a form is opened during бот runtime, click the form element to enter
or change the value.
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Ограничения

When you log in to the web interface as an administrator, for certain languages, the translated text
on the left navigation pane is truncated (not displayed completely).
Обходное решение. Hover over the menu item to view the tooltip, which displays the
completely translated text.

In the Google Cloud Platform instance of the AARI on the web interface, when you open a
request that contains previously uploaded files, you might intermittently experience an error while
downloading the files.
Обходное решение. Retry downloading the file.

If a form has a table element and you use the Set action from the Interactive forms package
during бот runtime, values are not applied to the table element.

If you selected the action trigger as Changed value for a Dropdown element within a trigger
loop, any associated event is triggered during бот runtime even when there is a Reset action.

Если при настройке SDS вы создаете запрос на отправку файла, отправка не удается и
отображается сообщение об ошибке SecurityTokenInvalidException.

The Override output variable option in the End Process endpoint is not currently functional for
users to override a variable definition.

Discovery Bot

Новые возможности

View Groups of steps
When reviewing a process view, you can now use the group option or icon to display groups
of steps that belong to the primary level action and secondary level action (and subgroup level
actions) used during the recording session.
Use the group icon to help you decide what groups of steps to select for a task you want to
automate. For example, a primary level action displays Microsoft Outlook, a secondary level action
displays Outlook mail notification, and subgroup level actions display terms such as Email -Add To,
Email – Add Subject.
Create a process view with branches and opportunities

Use Dynamic option for system-generated views
You can now use the Dynamic option from the Model options to view recordings where groups of
steps display a set of repeating patterns that belong to the same application or same primary level
action used during the recording session.
Use this option to decide the context of the process or the task you want to automate. Groups
of steps that are labeled belong to supported applications such as Microsoft (Excel, Outlook, and
Notepad), Notepad++, text editors, most windows use cases, and Chrome browser functionality.
Create a process view with branches and opportunities
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Новые возможности

Enhancements to PDD Word document
The PDD Word document now includes a process recording flow chart and the time on each
individual step in hours, minutes, and seconds.
Review opportunities and convert to

Исправления

ID обращения к облачному сервису Описание

-- The Control Room installer for Red Hat
Enterprise Linux (version 7.7 or 7.9) now
includes the Discovery Bot package. Previously,
you had to log in to the Control Room as admin,
select Manage > Package > Upload, and
upload the Discovery Bot package.

Ограничения

In a Linux environment, when you record a process using the Discovery Bot recorder, the
recorder window opens for 4 seconds and then disappears. The error occurs because the
ProcessDiscovery folder is missing in the following directory: /var/automationanywhere/
enterprise/appdata/Server Files/.
Обходное решение. Perform the following steps to create an empty ProcessDiscovery folder
manually and provide write access to the folder:
1. Navigate to the following path in the Control Room directory:

a. If you have updated from an earlier version to v.22, navigate to /opt/
automationanywhere/enterprise/appdata/Server Files

b. If you perform a new installation of v.22, navigate to /opt/automationanywhere/
automation360/appdata/Server Files

2. Run the sudo mkdir ProcessDiscovery command to create an empty folder for
ProcessDiscovery in the specified Control Room directory.

3. Run the following command to provide the required read and write permission for the newly
created ProcessDiscovery folder:
a. sudo chown -R crkernel:controlroom ProcessDiscovery/

b. sudo chmod -R 775 ProcessDiscovery/

When you upgrade to A360 v.22, you might receive multiple email notifications about the PDD
generated in A360 v.21.

Когда вы добавляете ветви с левой и правой стороны от основной ветви, раздел PDD «Запись
блок-схемы» может не захватить всю последовательность операций процесса, включая все
ветви.

© 2023 Automation Anywhere. All rights reserved.     386



    Automation Anywhere - Learn

IQ Bot

Новые возможности

IQ Bot standard forms integration with IQ Bot Extraction
You can now use the IQ Bot Extraction пакет for data extraction from standard forms documents.

Использование action IQ Bot Обработка документов

Confidence threshold applicable on standard forms learning instance
For a standard forms learning instance, if the Confidence threshold value that you have set does
not match any field, the document is moved to the Validator and a notification icon is displayed.
This update now enables you to validate the document for the learning instance and also save the
document.

Additional Распознавание текста (OCR) engines for IQ Bot Extraction пакет
In addition to the existing Распознавание текста (OCR) engines, IQ Bot Extraction пакет now
supports the following Распознавание текста (OCR) engines:
• Microsoft Azure 2.0
• Google Vision API

IQ Bot Extraction пакет

Export IQ Bot dashboard data
A user with the AAE_Администратор IQ Bot role can now export the following data from the
dashboard to a CSV file using the Export icon:
• Документы обработаны
• Страницы загружены
• Straight-Through Processing
• Точность

The CSV file is saved to the local Downloads folder.

IQ Bot support for self-signed certificates
You can create a self-signed certificate with Subject Alternative Name (SAN) to use an SSL
certificate for multiple domains.
Creating a self-signed certificate with Subject Alternative Name

Изменения

IQ Bot пакет supports external proxy server settings (Service Cloud case ID: 00727414,
00725235, 00757568, 00753560, 00753560, 00786609)
The Download all documents and Upload Document actions in the IQ Bot пакет now support
external proxy server settings.

IQ Bot Python library upgrade (Service Cloud case ID: 00756943, 00791511)
IQ Bot now uses Python version 3.9.5 for data extraction.
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What's deprecated

IQ Bot [Local Device] пакет
The IQ Bot IQ Bot [Local Device] пакет is deprecated from this Automation 360 v.22 (Сборка
10526). Instead, use the IQ Bot Extraction пакет, which provides the same capabilities as the IQ
Bot [Local Device] пакет, along with additional improvements.
IQ Bot [Local Device] package replaced by IQ Bot Extraction package (A-People login required)

Прим.:  Before using the IQ Bot Extraction пакет, update the боты associated with the IQ Bot
[Local Device] пакет and restructure the output folders.

IQ Bot Extraction пакет

Исправления

ID обращения к
облачному сервису

Описание

-- If you delete a .csv file from the Success folder, you can now
download the remaining files from that folder.

-- When you use the IQ Bot Extraction пакет for processing a large set of
documents, you no longer encounter any document processing issues
with Bot Agent.

-- If an incorrect value was used in the providerVersion field when
you uploaded standard forms configurations to IQ Bot, an error
notification is now displayed when you select this configuration when
creating a standard forms learning instance.

00806805 You can now import a learning instance using the Migration Utility
feature as the Invalid Group error message is now resolved.

-- When you creating a learning instance using standard forms, all the
available pre-trained models are now listed in the Select Model drop-
down menu.

00703856 IQ Bot now correctly extracts table rows with numeric values even when
they are within parenthesis.

-- The File Download API now returns a correctly formatted JSON
response with a colon (:) separating the key-value pairs.

00694656 IQ Bot now successfully extracts values from the documents that have
new table fields added after training.

00636887 An error notification is now displayed if you upload documents with
file names longer than 150 Asian language characters in the staging
environment.

Прим.:  This is not applicable to a production environment.

-- IQ Bot cloud data query is now optimized to prevent overloading of the
Amazon Relational Database Service.

00782994 When you use the Migration Utility to move a learning instance between
environments, unclassified data is no longer exported.
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Исправления

ID обращения к
облачному сервису

Описание

00747137 You can now import learning instances using the Migration Utility
feature without any issues.

Ограничения

The value displayed in the My totals > Accuracy field sometimes does not match the value in the
My learning instances > Field accuracy for the available learning instances.

If you try to import a learning instance into an IQ Bot environment that has a deleted learning
instance with the same name, the following message is displayed even though the learning instance
is not imported: Import process initiated

If you access IQ Bot without the correct permissions, they are redirected to an Access denied
page, where the back button does not work.
Обходное решение. Close the current tab and open the Control Room.

When you select Other domain in the learning instance creation page, the tooltips for the table
and form fields state that these fields are optional. However, these fields are required to create a
learning instance.

IQ Bot installation sometimes fails and the following message is displayed: Failed to upgrade
the DB: -1. When this issue occurs, retry the installation.

(ID обращения к облачному сервису: 01016516, 00757943, 00787404, 00788421, 00807528,
00822941, 01018972) If you add multiple ABBY Распознавание текста (OCR) based commands
(such as IQ Bot Pre-processor, IQ Bot Classifier, AISense Recorder, Распознавание текста (OCR))
in a single бот, an error message is displayed when you run the бот.
Обходное решение. Ensure that you do not add multiple commands in a single бот.

(ID обращения к облачному сервису: 01063054)You cannot import a learning instance with a long
name (>50 characters) because IQ Bot only supports up to 50 characters in the Label field.

If you use the Process documents action from IQ Bot Extraction пакет to upload documents, the
validation rules from the default the validation group that you set are not applied. As a result, the
failed documents are not classified into any of the existing groups and are moved to Валидатор.

В Community Edition IQ Bot, когда вы используете Распознавание текста (OCR) Cloud для
создания обучаемого экземпляра, если вы используете action Обработка документов IQ
Bot из пакет IQ Bot Extraction, значения из загруженных счетов-фактур или документов не
обрабатываются корректно.
Обходное решение. Если вы используете Распознавание текста (OCR) Cloud для создания
обучаемого экземпляра, используйте action IQ Bot Загрузить документ из пакет IQ Bot.

After you train a bot and click Save and go to next group, the system fails to load the next
group. Instead, it reloads the same group.
Обходное решение. Perform the following steps:
1. Refresh the page.
2. Navigate to Learning Instances and click Bots to edit the Learning Instances.
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Ограничения

System identified regions are not generated when a non-English filename is uploaded using the
Invoice domain and processed with the AutoExtract command.
Обходное решение. To process the document, convert the non-English filename to English
characters.

Bot Insight

Исправления

ID обращения к облачному
сервису

Описание

00788583 In the Profile tab, when you edit, save and generate a business
dashboard and the dashboard is not saved, the error message
description is now translated correctly in the Chinese language.
Previously, if an error occurred when you saved the edits in the
Profile tab of the Business dashboard, the error message
description displayed garbled text.

00729920 When you migrate a task from a source (UAT) to a target
(production) environment, a Published dashboard copy is no longer
deleted from the source environment.

00742260 You can now export data from operational or custom dashboards
after applying a non-metric variable in the filter. Previously, the data
was not exported when you toggled between different chart types.

00738228 Multiple dashboards are no longer created for a TaskBot when
you update and execute a бот that is checked out from the public
workspace. Previously, when a бот was executed after an update,
multiple dashboards were created.

00757992 A user with the Bot Creator license can now access all the Bot
Insight dashboards (Operations and Business tabs) irrespective of
their assigned role. Previously, if the user had the Bot Creator license
with the AARI Admin role, they were not able to access these
dashboards.

Ограничения

(ID обращения к облачному сервису: 00733555, 01912503) In a dashboard, the data labels in
the pie chart overlap if it contains many slices. As a result, the labels in pie chart are not clear and
shown only when you hover over the slices.
Обходное решение. To view the data labels in a pie chart in clear and readable format, export
the dashboard data to Excel file.

Прим.:  Due to a limitation within the third-party recharts library, you might observe labels
overlapping issue with data in downloaded PDF as well.
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Важное замечание:  Для получения информации о пакетах, поддерживаемых этим выпуском, см.
раздел View пакет versions available in the Control Room.

Заметки о выпуске Automation 360 v.21
Дата выпуска: 09 июня 2021 года
Review what's new and changed, and the fixes and limitations in the Automation 360 v.21 release.
Automation 360 (Cloud and On-Premises) is on Сборка 9664. Automation 360 IQ Bot Cloud is on Build
9664 and On-Premises is on Build 9642.

Patch release updates

We have updated Automation 360 Сборка 9664 (Cloud and On-Premises) for the following fixes:
• Process deployments containing forms with empty table, check box, or text box are failing after the

AARI Cloud build is updated from the previous release to this current release (Service Cloud case ID
00788255).

• The layout of the request view page changes when another language other than English is selected
(Service Cloud case ID 00772925).

• Warning messages in the process editors render garbled characters due to missing UTF-8 encoding
(Service Cloud case ID 00781891, 00784947).

• Users (with the attended license) are not redirected to the AARI Assistant application due to users
(without the attended license) trying to connect to the AARI Assistant application beforehand on the
same device.

• Not able to capture keystroke actions on an application using the Universal recorder (Service Cloud case
ID 00785310).

• Files were missing from the embedded resource folder, causing issues in using the Recorder package
(Service Cloud case ID 00767315, 00777786, 00775209, 00788523, 00797261, 00795511, 00785246).

• Бот deployments are getting stuck in a queue after Automation 360 Cloud is updated from the previous
release to this release (Service Cloud case ID 00784333, 00784890, 00784382, 00784338).

• Cloned боты are losing their dependency when they are checked-in (Service Cloud case ID 00780756).
• The recording duration was not updated correctly under Process Cycle on the process card, and the

recorded steps were not captured by the recorder (Service Cloud case ID 00790884, 00781022).

• Миграция
11.x и 10.x | Только 11.x | Только 10.x

• Рабочая область RPA

Новые возможности |  Изменения | Исправления | Ограничения
• AARI

Новые возможности |  Изменения | Исправления | Ограничения
• Discovery Bot

Новые возможности | Исправления | Ограничения
• IQ Bot

Новые возможности |  Изменения | Исправления | Ограничения
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Обновление до этого выпуска

Предусмотрена возможность обновить Automation 360 v.21 с трех предыдущих выпусков (то есть
с n-3 выпусков, где n означает последний выпуск). Перечисленные ниже предыдущие выпуски
сертифицированы для обновления до этого выпуска:
• v.20 (сборка 8815)
• v.19 (Builds 8147, 8145, 8122, 8098)
• v.18 (сборка 7560)

Вы можете напрямую обновить v.21 из любой из этих сборок. For details on how to update, see
Обновление до последней версии Automation 360.

Прим.:  Если вы не используете выпуск n-3, перед обновлением до данного выпуска обновите
Automation 360 до одного из трех сертифицированных выпусков.

Важное замечание:  This release includes a required update to your . Ensure that you complete the
update to continue with your automation activities when upgrading from a previous release to this release.

Автоматическое обновление Bot Agent | Обновление Bot Agent вручную

To verify which  version is compatible with this release, see Compatibility with release builds.
Enhancements to browser extensions: The Automation 360 extensions for Google Chrome (version
1.2.0.0), Microsoft Edge (version 1.2.0.0), and Mozilla Firefox (version 1.2.0.2) now include the following
enhancements:
• Support for HTML buttons and text actions in Interface trigger
• Enhancements to the default search criteria for text boxes and check boxes using Средство записи

package.
• Fixes for capturing objects with characters not valid in XML using the Средство записи package.
• Fixes to the Discovery Bot recorder with default browser (Google Chrome) search page.

Особенности миграции

Enterprise 11 and Enterprise 10 features

New system role to perform migration
Assign the AAE_Bot Migration Admin system role to the user who will perform migration. This
role contains all the permissions required to view and manage the бот migration process. Using this
role eliminates the manual effort of creating custom roles, selecting the required permissions, and
assigning them to the users who perform the migration.

Enhanced бот runtime window
When you migrate боты using the Bot Migration Wizard, the бот runtime window now shows the
name of the Enterprise 11 or Enterprise 10 бот file that is currently migrated.

You can now migrate боты with the Open webpage in a new window and Open a webpage
in an existing window settings.

You can now migrate Enterprise 11 and Enterprise 10 боты with multiple versions of a DLL.

© 2023 Automation Anywhere. All rights reserved.     392



    Automation Anywhere - Learn

Только для Enterprise 11

MetaBot screens: Custom objects and play mode enhancements
• Custom objects within the Image play mode are now fully supported.
• Linked objects are now captured.

Enhanced Hide/Show option in Control Room
For боты available in the Control Room (the My bots folder), a filter is available to hide or show
older .mbot and .atmx files displayed in the window.

Global values for SAP
The migration process creates the JcoDllPath and JcoJarPath global values of type string to support
migration of SAP BAPI.

Enhanced База данных action functionality
The База данных action now supports connecting to Oracle databases using SID and or
Service_name. In previous releases, only connecting with SID was supported.

New email variable strings
New email sent and received string variables are available for the Цикл, Import DataSet, and
Export Dataset actions to insert sent values for date and time.

Enhanced Microsoft Exchange Web Services support
The Send function in the Эл. почта пакет supports EWS OAuth2.0, improving backward-
compatibility.

Manually migrate from Enterprise 11 to Cloud-enabled environment
You can now manually migrate from Enterprise 11 to a Cloud-enabled environment. In this
migration, you must create all the entities such as users, roles, and credentials manually, except
боты. All Enterprise 11 versions are supported for this migration.

Подготовка миграции с Enterprise 11 на Automation 360 с поддержкой облака

Только для Enterprise 10

Migrate MetaBots screen with Password type variable
You can now migrate Enterprise 10 боты based on the MetaBot screen, which uses the Password
type variable. During the migration, the logic (.logic file) in the .mbot file is migrated as a new
TaskBot within the MetaBot folder. Also, the Password type variable is migrated as a credential
variable and is assigned to a predefined ячейка.

Migrate TaskBots based on MetaBot Screen and DLL assets without using Logic
You can now migrate a TaskBot that references the Run MetaBot action for the MetaBot Screen and
DLL assets directly, without using the MetaBot Logic. So you can migrate a TaskBot that contains
MetaBot Screen and DLL assets.
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Рабочая область RPA

Новые возможности

Automation 360 navigation enhancements
We have enhanced the overall readability and accessibility of the Automation 360 interface. To
make navigation easier, menus and views are organized based on frequently used features and
related tasks.
The interface includes the following updates:
• The Device, Profile, and Help icons are now located at the bottom of the navigation menu,

consolidating all controls on the left for easy access.
When you click these icons, flyout panels of content and actions are shown.

• The side navigation menu can be collapsed to a slim bar to maximize the main workspace area.
You can continue to use the side navigation in collapsed mode, with flyouts for each section.

Automation 360 navigation updates

Authenticate database connection with Microsoft Azure Active Directory credentials
(Service Cloud case ID 00676448)
You can now authenticate the Control Room database connection using Microsoft Azure Active
Directory credentials when you install the Control Room on Microsoft Azure.
Configure Microsoft database type and server

External Key Vault enhancements
External Key Vault support for AWS Secrets Manager and CyberArk for Auto-login and Automation
credentials has been added to Automation 360. Auto-login credentials and Automation credentials
(credentials used by bots) can now be retrieved from the configured external key vault.
Integrate external key vaults

Deploy workload automation on a multi-user Windows terminal server
To optimize workload automation and multi-user devices, you can deploy workload automations
on a multi-user Windows terminal server so that a single device can process multiple work items
concurrently.
About multi-user devices | About device pools

Control Room and Bot Agent compatibility checks for automation
To manage the lifecycle of your automation, you can view dependency information about minimum
compatible Control Room and Bot Agent versions when you create and deploy automations. You
can then update your automation and reduce runtime errors caused by an incompatible Control
Room or Bot Agent version.

Действия palette for бот creation

New actions in the SAP BAPI пакет
Use the following new actions:
• Run standard workflow: Runs a standard workflow in SAP BAPI.
• Run custom workflow: Runs a custom workflow in SAP BAPI.

пакет SAP BAPI
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Новые возможности

Новое actions в пакет Файл
Use the following new actions:
• Get name: Reads a file name and stores it to a string.
• Get path: Reads the path of the file and stores it to a string.

Файл пакет

Common table expression supported in База данных пакет
You can now use common table expression (CTE) in the Read from action using the WITH
keyword in SQL-compliant databases such as Oracle and MySQL. Use CTE statements within a SQL
query to simplify complex joins and subqueries.
Using the Read from action

Support for large numbers in Число пакет (Service Cloud case ID:00557619)
You can now perform mathematical operations for large numbers with more precision in the Число
пакет.

Число пакет

Snowflake database support using OBDC driver (Service Cloud case ID:00761695)
Snowflake OBDC driver is now supported in the База данных пакет. You can connect to the
Snowflake database using ODBC-based client applications.
The following actions support this feature:
• Подключить
• Отключить
• Прочитать из
• Экспортировать в таблицу данных
• Вставить/обновить/удалить

Variables: new features and enhancements (Service Cloud Case ID:00740585)
• Edit the variable name after the variable is created.
• Delete all or a specific selection of unused variables from a бот.

Universal Recorder new features and enhancements
• Record object interactions in applications built on the Electron framework.
• Perform double-click in all supported applications and browsers.

Limit credential attribute use to password fields only (Service Cloud Case ID:00740585)
When you create or edit a credential attribute, ensure that боты input the attribute value only in
fields that are identified as password fields by selecting the Set this attribute as a password
option.

Organize device pools to check for available devices in a preferred order
If you select multiple device pools (either in the Run now or Schedule window), you can now
arrange the device pools in the order of preference. When a бот is deployed, the Control Room
selects the first available device based on the order in which you organized the device pools. If
none of the devices are available at the time of deployment, the бот is queued.
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Новые возможности

Default names for output variables
When you configure an output variable for the actions in the Обработчик ошибок and Python
Script пакеты, the Control Room automatically generates a descriptive default variable name. If you
create more than one output variable for an action, the subsequent variable names are appended
with a -1, -2, -3, and so on to avoid a variable name conflict.

New string action to support nested variables
Use the String > Evaluate value action to compare a user-specified string variable with the string
variables in the бот. If a match is found, the action returns the value of the matching variable.

Строка пакет

Delete Global values
A user with the AAE_Администрирование role can delete a global value from the All global
values page.

Глобальные значения

High availability support
For Cloud-enabled users, high availability is supported through three-node deployments.

Строка пакет enhancement
A new option to support local numbering styles is now available in the Строка пакет. You can now
select your local format, represented by ISO-3166.

Dependent files and package information in Export package audit details
In the Audit details of an exported package, you can now view the list of dependent files and
packages associated with the exported package. This feature enables you to analyze what the
exported package contains and identify any discrepancies. If you chose to include packages during
an export, then only the package information is included in the audit details.

ODBC driver support for all connection strings (Service Cloud Case ID: 00748887, 00777676)
An Open Database Connectivity (ODBC) driver is now available to support all the ODBC connection
strings in the same way it was used in the Enterprise 11 version. Using SQL as a standard for
accessing and managing data, you can connect to MySQL, Google BigQuery, Snowflake, and other
databases using the ODBC driver.

Share a DLL session
You can now share a DLL session between боты.

New CredentialAllowPassword annotation
Use the new CredentialAllowPassword annotation in the package SDK to allow the selection of
a credential attribute marked as a password. You can use this annotation when creating a new SDK
package or when modifying an existing one.
Configure and use credential allow password annotation
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Новые возможности

Enhancements to check-in, check-out, and cloning permissions (Service Cloud Case ID:
00645904, 00720237, 00752197, 00760306, 00764684)
• When performing a check-in, you can now choose the dependencies to check in along with the

бот. Directly referenced dependencies will be automatically checked in with the бот.
• When a бот is checked in along with a cloned бот and there are no other боты dependent on

the clone, the cloned бот is now deleted.
• When performing a check-out, you can now choose the dependencies you want to check out

with the бот. The dependencies that are not selected during the check-out are now cloned.
• During check-out, you can now overwrite or replace a cloned бот.

Bot Agent installer includes shortcut for AARI Assistant
A shortcut to access AARI Assistant easily is added on the desktop and Windows menu when you
install a Bot Agent.

Установка Bot Agent и регистрация устройств

Изменения

Bot Scanner shows invalid боты in "cannot be migrated" list
The Bot Scanner is updated to show invalid боты as blocked from migration because these invalid
боты were failing before and after migration. For example, Enterprise 11 or Enterprise 10 боты
that referenced non-existent variables failed. So some боты will no longer be shown in the can
be migrated list of боты but will instead be shown in the cannot be migrated list in the output
report. This can decrease the number of боты that can be migrated to Automation 360.

Change in names of file locations and folders
File locations and folder names are now updated for the change in product name (from Enterprise
A2019 to Automation 360). For example, the file location for the default installation path is changed
from C:\Program Files\Automation Anywhere\Enterprise\ to C:\Program Files
\Automation Anywhere\Automation360. We will be updating these locations and names on
our documentation pages soon.

Source string is optional in Split action (Service Cloud case ID: 000687257, 00702258)
In боты (including боты migrated from Enterprise 11), when you use the Split action in the Строка
пакет, the Source string field is now optional. You can run the бот without providing a source
string value. Migrated боты that contain empty input strings now execute successfully.

Mandatory prerequisites validation before migrating бот
When you migrate боты using the Migrate bots option in the Bot Migration Wizard, a prerequisite
validation message appears with a checklist of all the validation items. The system now validates
these prerequisites automatically to ensure that all prerequisites are met before you start the бот
migration. Previously, validating prerequisites was optional.
If the prerequisite validations are completed with a failure, a validation report appears with the list
of items for which validation failed. If the prerequisite validations are completed without any failure,
the бот migration is started.
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Изменения

Change in default Control Room database name
The default Control Room database name is now changed from AAE-Database to Automation360-
Database.
If you are upgrading from an earlier release to this release, enter your existing Control Room
database name to preserve your data.

Microsoft SQL Server clustering for high availability
You can now use Microsoft SQL Server clustering for automatic and graceful failover of high
availability deployments in Control Room clusters.
Database requirements

Bot Agent nickname is hidden
The nickname of a Bot Agent (added during installation) is now hidden when you switch the
registration of a user device from one Control Room instance to another.

User interface change in the Open action of Excel пакеты
In the Базовый Excel and Расширенный Excel пакеты, the Sheet contains header check box
now appears below the Select file field.

User interface change in the Variables palette
• The User-defined variables list is now named Your variables
• System, String, and Clipboard variables are organized within Predefined variables

Digits with comma considered a valid number (Service Cloud case ID: 00623458)
In migrated боты, a set of digits that uses a comma is now considered a valid number. This
change enables you to successfully verify mathematical operations and If, ElseIf, and Loop variable
conditions containing various operators.

Date comparison works with dates in different formats (Service Cloud case ID: 00723479)
Date condition actions are now successfully migrated to the equivalent date conditions in On-
Premises. The date condition now works with multiple subformats of the main format (MM/dd/
yyyy). Therefore, you do not have to manually change the date format per the source format of the
migrated боты that contain date strings.

Use string value with numeric operators
Migrated боты that contain Если or While actions that use string values or a variable containing a
string value with <, <=, >, and >= numeric operators now run successfully.

Enhancement to Extract field action in PDF пакет
Use the PDF viewer in the Extract field action to extract all the form field data and selected text,
and store the form data to variables.
Using the Extract field action
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Изменения

Connect automatically to SQL server for Windows authentication (Service Cloud case ID:
00691554)
When you upgrade the Bot Agent, you no longer have to add dll files manually to connect to the
Microsoft SQL Server using Windows authentication.
Previously, users had to manually add dll files to configure devices and use the Connect
action from the База данных пакет to connect to the Microsoft SQL Server with Windows NT
authentication.

Enhancement to Active Directory mapping
You can now create AD groups using commas in the naming on the AD server side and the Control
Room side. Previously, this caused an error.

Enhancement to the Split action of Строка пакет
Migrated боты now run successfully when the Split action is used to split a string available in an
input variable and that variable is empty.

В приведенной ниже таблице перечислены исправления и сборки, в которых были сделаны эти
исправления. Сборка 9664 is the latest build for Cloud and includes fixes from the previous builds. On-
Premises is on Сборка 9664.

Исправления

Сборка ID обращения к облачному
сервису

Описание

9664 00803314 The following issues are fixed in the latest
version of the Cloud Migration Utility:
• The utility checks the current version of

your Enterprise 11 Control Room and
proceeds only if that version is supported
for migration to Automation 360.

• The utility displays the target tenant
information on the successful validation
screen when you navigate to the
migration code screen.

• An error is no longer encountered
when access is provided to: https://
aws.amazon.com and https://aa-
provsvc.globalservices.automationanywhere.digital/

• The utility uploads all the required data to
Automation 360 Cloud.

9664 00790884, 00781022 The recording duration for a process is now
correctly displayed under Process Cycle on
the process card. Previously, you were not
able to view the recording duration because
of a delay in the network connectivity. You
can now view all recorded steps captured by
the recorder from the Recordings page.
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Исправления

Сборка ID обращения к облачному
сервису

Описание

9664 00785310 You no longer encounter any issue when
you use Universal Recorder to record
keyboard actions on an application. The
Universal Recorder now captures the value of
keystrokes properly. Previously, the Universal
Recorder captured only the first value of the
keystroke.

9664 00767315, 00777786,
00775209, 00787736,
00797261, 00795511,
00796245, 007956217,
00798533, 00795084

You no longer face issues because of global
cache expiry and partially deleted files
in the embedded-resources folder (C:
\ProgramData\AutomationAnywhere
\GlobalCache\embedded-resources)
when you install a Bot Agent for this release
and capture objects in Google Chrome using
the Средство записи package.
Note that, if the Bot Agent device has
embedded resources folder partially deleted,
you must first delete the global cache and
update the Bot Agent.

9664 00796598 When you run workload боты with queue
on Bot Runner devices, the боты do not fail
intermittently after Automation 360 Cloud
is updated from the previous release to this
release.

9642 -- Control Room instances configured with
Active Directory for authentication with the
retrieval of credentials from an external key
vault were unsuccessful due to incorrectly
prepending domain names in object names
(CyberArk) and secret names (AWS) and
caused authentication to fail. This issue is
now fixed and object names (CyberArk)
and secret names (AWS) are now properly
formatted.

9637 00784333, 00784890,
00784382, 00784338,
00780635, 00791587,
00795559, 00795632,
00797130, 00797113, 00791783

Бот deployments are no longer stuck in a
queue after Automation 360 Cloud is updated
from the previous release to this release.

9637 00780756 You can now check in боты that have
a shared dependency with other боты
successfully. Previously, check-in failed
because of an issue with the cloned боты
losing the dependency during check-in,
irrespective of their existing parent боты.
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Исправления

Сборка ID обращения к облачному
сервису

Описание

9595 00733638, 00756399 Боты that use a variable to specify the child
бот to run no longer encounter an error
because the variablized path contains a
backslash.

9595 00711390 The retry mechanism now enables you
to migrate large .atmx files. Previously,
when a large .atmx file was migrated, the
connection with the Control Room became
stale or unauthenticated, resulting in a
NoHttpResponseException error. With
the retry mechanism, the Migration utility
attempts to build a connection with the
Control Room 5 times until the connection is
successfully rebuilt.

9595 00730369, 00747866 Recorder actions now work properly, which
enable you to run the migrated бот without
any delay. Previously, it took a longer time to
run the бот due to a long delay.

9595 00733383, 00754559 The Цикл counter variable now works
properly for migrated боты. The variable is
now migrated as part of the XML and the
Data Table commands.

9595 -- When updating the SQL queries on a
migrated бот using the Read from and
the Insert/Update/Delete actions of the
Database package, the existing format of the
query is no longer automatically modified.
Previously, when editing the SQL queries on
a migrated бот, the characters were being
misplaced.

9595 00721238 You can now use the Browser action to
access a URL with parameters using the
Microsoft Edge browser. Previously, when a
URL with parameters through the Browser
action was accessed using Microsoft Edge,
the URL parameters were truncated from the
& (ampersand) character after the бот was
run.

9595 00721488 Enterprise 11 боты that use the Get
multiple nodes command no longer provide
a different output after migration. Previously,
the migrated бот returned output per the
structure of the XML file, while the Enterprise
11 бот provided output in a single line.
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Исправления

Сборка ID обращения к облачному
сервису

Описание

9595 -- You no longer encounter an issue when
you run боты migrated from Enterprise
11 that use identical names for variables
differentiated by a hyphen or an underscore
(for example, L-Lower and L_Lower). The
variable name that contains a hyphen is now
appended with some keywords (for example,
variable Arr-val is updated to Arr-val-MIG-
SPL-25). Previously, боты failed to execute
after migration.

9595 00729931 After migration, when the бот file is
generated, the correct DOMXPath is now
migrated. Previously, an incorrect DOMXPath
was migrated.

9595 00738643 The If and Loop conditions when used
in a combination of multiple AND or OR
conditions now works properly. Previously,
using the If and the Loop conditions with
multiple conditions resulted in a бот logic
error.

9595 00743808, 00754554 Migrated боты that use the Если command
with a variable in the HH:MM format now
work properly and no longer encounter any
issue.

9595 00678059 You can now download exported packages if
the бот name contains Japanese characters
and an underscore (_). Previously, if
the name contained such characters, an
unexpected error occurred that restricted the
user from downloading the package.

9595 -- When you run a migrated бот that contains
the Excel Advanced > Find action, the
found cell is now active and subsequent
actions can perform operations on that active
cell.

9595 00731512 You can no longer edit a бот and change the
бот repository file path from the public to
private folder by updating the Control Room
URL and repository path in the browser.

9595 00734059 INFO type messages are no longer duplicated
in the Control Room WebCR.log file.

9595 -- When you install a Bot Agent at the user
level, the user device is now registered as
admin.

9595 00744663, 00747831,
00737488, 00752613

You can now successfully export a бот that
contains the Средство записи пакет.
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Исправления

Сборка ID обращения к облачному
сервису

Описание

9595 00726433 Fixed an issue with Microsoft Graph APIs that
caused errors when a бот downloaded files
from OneDrive. Боты can now successfully
run the Office 365 OneDrive > Download
file action.

9595 00703553 When a new user is created, the Audit
API now returns the correct values for
the eventDescription and userName
parameters.

9595 00729563 The atmx file extension is no longer case-
sensitive. You can now migrate tasks that
include uppercase or lowercase letters in
their file extensions. Previously, tasks with
uppercase letters in their file extensions were
not migrated by the Bot Migration Wizard.

9595 00740548 Бот status is now correctly displayed after a
process is executed. Previously, scheduled
боты were occasionally mislabeled as In
progress activity even though the бот
had completed the process.

9595 00731508 You can now enter Nordic characters in the
credential attribute and credential variable
values.

9595 00695176, 00692676 Newly copied боты containing an event
trigger now run when the triggering event
occurs.

9595 00759742 When you insert a variable in a text string,
the variable is now inserted at the cursor
position. Previously, the variable was inserted
at the end of the string and not at the cursor
position.

9595 -- You can now successfully deploy боты
from the Bot editor. Previously, when the
Bot Creator or Bot Runner (attended or
unattended) user logged in to the Control
Room and if the пакет download option was
enabled, the пакет download took priority
and бот deployment had to wait until the
пакет download was completed.

9595 00730211 When you use the Средство записи пакет
> Get property action to extract the path
property of the object, the recorder now
retrieves the value of the height and path
attributes of the captured object. Previously,
the height and path attributes of the recorded
object were not retrieved by the бот.
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Исправления

Сборка ID обращения к облачному
сервису

Описание

9595 00716793 An issue is no longer encountered when you
execute a бот using the Веб-служба SOAP
пакет with unformatted input parameters.
Previously, бот execution failed with an error
because the unformatted input parameters
were not formatted in XML format by the бот.

9595 00706709 In the Эл. почта пакет, when you use the
Outlook connection to retrieve emails with
the date filter, all emails are now retrieved
correctly. Previously, all the emails were not
retrieved from the application when the date
filter was applied.

9595 00714292 To support double backslashes (\\) in the
file location for actions that use file input,
you must now set the Bot compatibility
version as 2 in the Advanced settings
page of the Bot editor. Previously, the
бот execution failed because the double
backslash (\\) in the file location was replaced
with a forward slash when you select a
network path using Browse option.

9595 00697460 When you select the recorder in the Если
condition, the recorder now locates the
object in the Oracle EBS application and
captures the correct object properties without
any error. Previously, the recorder failed to
find the object when captured in the Если
condition.

9595 -- In Microsoft Edge or Firefox, when a бот
opens a website inside a loop, the Средство
записи Capture action now works properly
after the launch website operation is
executed. Previously, the action failed after
launch website was executed.

9595 00710257 In the Средство записи пакет, the Capture
action now works without encountering any
issues. Previously, the Средство записи failed
with a timeout error because the network
proxy details were not retrieved.

9595 00735480 A TaskBot now performs better when you use
the Loop action to execute a бот. Previously,
the TaskBot took a long time to complete
execution.
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Исправления

Сборка ID обращения к облачному
сервису

Описание

9595 00559868 When you use Дата/время пакет > Assign
action to convert a DateTime variable using
the custom format dd-MMM-yyyy, the бот
now executes without any errors. Previously,
the бот execution failed due to case-sensitive
characters in the DateTime format.

9595 -- Migration of PaaS database (Azure SQL)
connection strings by using an ODBC driver is
now supported.

9595 00733651 You can now view the average time spent to
create a TaskBot metric in the Control Room
on different pages when you click a page
number.

9595 00742305 When you turn off one node on a three-
node cluster and log in to the Control Room,
the following error is no longer displayed:
Cluster group is empty.

9595 00712190, 00698197, 00700574 When you deploy a бот with string values
that exceed the allowed limit of 2 - 4 MB, the
Control Room recognizes it as an exception
and now shows the following error message:
400 Bad Request.

9595 00754585, 00755448 When you run a бот, dependencies including
the child боты are now downloaded. The
бот no longer shows an unknown status and
session as expired.

9595 -- When you now migrate the База данных
command, no additional configuration is
required.

9595 00745046 You can now check in your боты without
encountering any issues. Previously, бот
check-in failed because the Git repository was
corrupted intermittently.

9595 00677638 When you add a user device as the default
device in the Control Room, the Devices
page now automatically displays it as the
default device. You no longer have to re-log
in to the Control Room or refresh the Control
Room page.

9595 00733370 Users signed in to temporary (non-persistent)
shared devices can now sign in to the
Control Room after a previous session on the
temporary device is deleted by the Control
Room administrator.
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Сборка ID обращения к облачному
сервису

Описание

9595 00736950 MetaBots using Japanese characters (double-
byte string) as the output variable can now
be successfully saved and executed after the
MetaBots are migrated to On-Premises using
the migration wizard.

9595 00723924 The Terminal Emulator type ANSI now
accepts a password that contains braces or
{}. Previously, when braces were used in the
password, an invalid username and password
error message was shown in the terminal
screen.

Ограничения

(ID обращения к облачному сервису: 00797199) If multiple instances of Bot Agent in Google
Chrome browser are displayed and multiple Google profiles (accounts) are open in the browsers,
you might not be able to use the Recorder > Capture command. You might see an error message
that informs you that the Google Chrome plug-in not installed.
Обходное решение. Automation 360 supports only a single profile for automation. Therefore,
we recommend that you either configure a single Google profile in Google Chrome or, if you are
using multiple profiles simultaneously in Google Chrome and want to automate one profile, enable
the Automation 360 extension for Chrome on only one of the Google profiles.

(ID обращения к облачному сервису: 01071731) When you open a CSV or TXT file, read data
from that file, and write the data from a Table type variable to the file, the бот fails with an error
if the CSV or TXT file contains large data sets. Also, Create folders/files if it doesn't exist and
Override existing file check boxes are selected in the Write to file action.
Обходное решение. Perform one of the following:
• In the task, when you use the Open action for a CSV or TXT file, select the Contains header

check box to prevent your бот from failing.
• Use the Расширенный Excel Open action to open a CSV file and then use the Write from

data table action to write data into the file.

(ID обращения к облачному сервису: 00793818) If you edit a large number of schedules
simultaneously (for example, more than 40) in the Control Room from the Scheduled activity
page, the schedules will not be activated.
Recommendation: Use the edit option for each schedule to avoid overwhelming the scheduler.

(ID обращения к облачному сервису: 00805571) When the Bot Agent is automatically updated
for Cloud deployments, the status of the Bot Agent flickers (changes) between Connected and
Updating on the Devices page. The Bot Agent logs indicate that the auto-update process is
initiated, but the device does not connect to the WebSocket server.
Обходное решение. Delete the local database file AA-DB.mv.db from C:\Windows
\System32\config\systemprofile\AppData\Local\AutomationAnywhere and restart
the Bot Agent service. If auto-update is enabled in the Control Room settings, the Bot Agent will
be updated automatically. Note that if the setting is disabled, you have to update the Bot Agent
manually.
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Ограничения

If a device or Bot Agent service restarts when you are running боты, the боты are shown as
Active in the Activity page instead of Failed because of response schema changes in the
product.
Обходное решение. Delete the AA-DB.mv.db file from C:\Windows\System32\config
\systemprofile\AppData\Local\AutomationAnywhere and restart the Bot Agent service.
The deployments stuck in Active state will be moved to the Historical page and will be marked as
Failed so that subsequent deployments can continue to run.

Intermittent issues occur with the execution of scheduled боты where some existing schedules
behave inconsistently or some newly created schedules disappear. The new feature to set the
priority to High has been reverted to address this occurrence. For users who have used this feature
in Build 9637 or earlier and have updated to Build 9664, the schedules work without the relevance
of the priority setting.
Обходное решение. If you encounter these issues, split large scheduled automation to smaller
schedules of 2 hours each to run throughout the day. For example, reconfigure an automation that
is scheduled for a 12-hour period such as 9 AM to 9 PM daily to two-hour intervals such as 9 AM to
10:59 AM, 11:00 AM to 12:59 PM, and 1:00 PM to 2:59 PM. We strongly recommend that you use
2-hour intervals in such deployments. Further recommendations for schedules and time intervals:
any schedules with a lower time frequency ( < 10 minutes) should be spaced out to at least 10
minutes (Service Cloud case ID 00792385, 00785679, 00795915, 00793147, 00794555).

Known behavior for configured ports on multiple instances
When you install the Control Room and configure the database, the ports for multiple instances
should match the TCP ports configured in TCP/IP properties. For example, for the first instance
if the configured TCP port is 1434 and for the second instance the configured TCP port is 1435,
ensure you add 1434 as the port for the first instance and 1435 as the port for the second instance
during Control Room installation.

The Universal Recorder has the following limitations when capturing objects in Electron apps:
• The Check action in a check box is not currently supported.

Обходное решение. Use Toggle, Click, or Left click instead.
• The Universal Recorder cannot capture tabular data.

Обходное решение. When the Universal Recorder captures an object control of Client,
select the GetAllChildrenNames action and store the data to a list variable.

• The Universal Recorder might capture the window containing Microsoft Teams as a Client
technology, instead of the intended object.
Обходное решение. Close and reopen Microsoft Teams.

• The Universal Recorder only supports object capture from Electron apps in a computer that has
the display scale configured to 100% or has a DPI awareness setting.

If the maximum number of allowed activeMQ connections is exceeded, an AMQ failure can occur
when running a RunTask automation that is looped 5 times, with each loop running 20+ боты after
the fourth loop.

External key vault
The Create/Edit User configure options still include the field permitting the administrator to enter
the device credentials for the user. When auto-login is configured for the external key vault, these
fields are still viewable and appear editable; however, the credentials added have no effect on the
auto-login credential retrieval from the external vault.
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Ограничения

You might observe an increase in CPU usage by about 10 percentage when the Control Room is in
an idle state (Service Cloud case ID 00801733).

When you update the Control Room on Linux from Automation 360 v.19 or v.20 to Automation 360
v.21, the Control Room continues to display the interface from the previous version.
Обходное решение. Refresh the browser to load the user interface in the new version.

Automation Anywhere Robotic Interface (AARI)

Новые возможности

AARI Assistant for attended Bot Runner
The AARI Assistant application enables users with the attended Bot Runner license to access their
боты without logging in to the Control Room. AARI web users can use the AARI Assistant when the
attended Bot Runner license is enabled along with their AARI User license without impacting their
existing functionality.

Сведения о AARI Assistant

Download, delete, or view files in browser in initial forms or tasks
Users can now use the Select File element to download files that are uploaded to the initial
forms or tasks, and they can also delete files or access the hyperlink file to view the file in within
the browser. The uploaded file can be accessed as a hyperlink, and new icons are available for
download and delete.

Enhancement to team roles
The AARI team consists of three roles:
• Member: Can create, view, and delete their own requests. All the tasks are automatically

assigned to the member when they create the request in a private team. In a shared team, the
member can assign tasks to other members.

• Owner: Can create, view, delete, and assign all the requests from the members in the team.
• Admin: Can create, view delete, and assign all the requests from the members in the team. The

admin can also modify the team.

An AARI admin or manager can edit their teams and update their team members' roles. They also
have the option to add or remove team members. The AARI manager is the team admin by default
when they create a team.

Enhancement to creating requests
A request can now be created either by a user or by a бот in the Edit Process page.
• Choose the by user option to view the process in the Processes page.
• Choose the by bot option so that the request is created either by a бот or by another process

using the Process Task.
You cannot view the process or create a request with this option. Because the request is created
from within a team, specify the default team in the Default team to take the bot created
request field in the Edit Process page.

Assign an AARI team to a process
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Новые возможности

Assign to me feature in tasks
When a task is unassigned and users access the tasks, use the Assign to me option to allow the
tasks to be assigned to the current user so that they can immediately access the form.
Assign or unassign a task

New Бот page
When AARI team members with attended Bot Runner licenses access the web interface, they are
automatically redirected to AARI Assistant. Users can view all the боты created by them on this
page. They can also pin, search, and sort their assigned боты.

New team reference in Request and Process pages
The user can now reference the team from which a request is created by referring to the new
Team column in the Request page or the team name added in the process tile in the Process
page, to help guide their team assignment.

New Request Visibility field (Service Cloud case ID: 00718119)
Request visibility enables users to allow or restrict access to a request they created to other team
members. When the Request Visibility field is set to Shared, all the requests are accessible by
all members, owners, and team admins. If the field is set to Private, the requests are available
only to the user who has created the request, owner, and the team admin.

Enhancement to the Processes page
The following enhancements are available on the Processes page:
• Sort the processes by name, in ascending or descending order.
• Toggle the pinning of a process.
• Use the responsive view to adjust the display to the screen size.

Cloud storage usage
Based on the maximum file and storage sizes, users who upload files can use cloud storage. The
quota for storage is as follows:
• The size of the file uploaded using the Select File element cannot exceed 25 MB.
• By default, the storage can store a maximum of 100 MB of data.
• It is extended to an additional 1 GB for every AARI user license allocated.

Copy process to URI feature
The AARI admin can use the new Copy process to uri to clipboard feature in the Process
setup page to obtain the URI data and share with team members as reference when they enter
the URI data to the Create a Request action.
AARI Web пакет
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Новые возможности

Add rows from header row context menu
Only the header row is displayed when a form that has a table is launched during бот runtime. Use
one of the following methods to add new rows to the table:
• Header row context menu of the table

Использование элемента «Таблица»
• The Set action in a бот

Задать action

Support for interface triggers on Google Chrome
Interface triggers are now supported on the Google Chrome browser for the following actions
during бот runtime:
• When you click a button element in a form
• For Got focus and Lost focus actions in a text box
• When a preconfigured hot key is used with the Got focus action in a text box

Add an interface trigger

Изменения

Upgrade changes to teams and processes
For users who had access to processes, when they upgrade to the latest Automation 360 version,
their existing teams remain the same but is now set to a shared team type, regardless of their
existing team assignment. AARI users and managers, are now converted to member and admin
team roles, respectively. While any existing processes assigned to your team are shown as Team
Migrated for Process after the upgrade.
For AARI managers (process manager) who could create requests without assigning process to
teams. After the upgrade, the AARI managers must create teams, ask the AARI admin to assign
teams to a process in order to create new requests.
Processes have the by user option set by default for teams to view a process. You must choose the
by bot option to have request be created by боты or another process.
Using AARI on the web interface | Assign an AARI team to a process

Update to Auto Assign feature
• In the Human Task, you can no longer use the auto-assign feature to assign the task

automatically to the manager. You can auto-assign the task to the user who created the request.
• The option to assign the target task to the manager is now removed from the Go to element.

You can now override the previous auto-assign setting by selecting the Override task
assignment setting option in the Go to panel by either unassigning the task or assigning the
task to the user who created the request.

В приведенной ниже таблице перечислены исправления и сборки, в которых были сделаны эти
исправления. Сборка 9664 is the latest build for Cloud and includes fixes from the previous builds
(including Build 9604). On-Premises is on Сборка 9664.
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Сборка ID обращения к
облачному сервису

Описание

9664 00788255 After upgrading from v.19 to this release version,
processes containing forms with the Table,
Checkbox, or Text Box element now execute
successfully. Previously, if the process contained a
form with an empty table, check box, or text box, it
failed during execution if no changes were made in the
form.

9664 00772925 The layout of the request view page no longer
changes when the user selects a language other than
English.

9664 00781891, 00784947 Warning texts in the process editor now render
correctly with UTF-8 encoding.

9664 -- Users with the attended license are now correctly
redirected to the AARI Assistant application when they
log in from the same device where a user without
the attended licenses tried to access the application
beforehand.

9604 00765406 When you enter more than four number values with a
comma in a Number element field in the initial forms
or tasks, the field can now accept the large number
value without issues.

9595 00719862 In the Team Setup page, you can now view the
members of your team and check if the member count
is consistent with the number of team members.

9595 00738934 Users can now view, upload, download, or delete their
files when they add the Select File element to forms
to complete tasks in the web interface.

9595 00767008 When you upload a file with the Select File element
in your tasks, the бот now downloads your file through
the Get Storage file action without issues.

9595 -- Long text for the label name of Radio button and
Checkbox elements in a form is now displayed
completely.

Ограничения

(ID обращения к облачному сервису: 00831376) When you use the storage service to upload or
download files from the web interface, the download is redirected to an AWS and GCP presigned
URL. You will not be able to download files unless you whitelist the AWS and GCP URLS.
Обходное решение. You must whitelist the following URL in order to download:
• AWS: https://<bucket-name>.s3.<region>.amazonaws.com/
• GCP: https://storage.googleapis.com/<bucket-name>/
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Ограничения

(Service Cloud case ID 00789181) When a бот is deployed in AARI and the deployment is not
completed even after an hour, the бот fails and the status changes to failed in AARI. However
the same бот still executes in the Control Room.
Обходное решение.
Choose one or both of the following options:
• Define an adequate duration for your бот execution.
• Increase the size of your device pool.

For On-Premises, when you log in to AARI Assistant application as a non-attended user, it shows
an error as expected. However if you use that same credentials, or credentials from another non-
attended user, and log in again to the application, it takes you to the web interface page.
Обходное решение.
1. Log in to the AARI Assistant application as an attended user.
2. First, log in to the web interface (aari/#/assistant URL) then log out without changing

anything in the browser. Second, navigate to the AARI Assistant application on your desktop
and log in as an attended user.

The Teams column in the Process setup page is not automatically updated when the AARI admin
adds or removes their team in a process.
Workarounds: Use the following options on the Process setup page:
• Click the Refresh the list option.
• Click the browser's refresh option to reload the page.
• Navigate to another tab then return to this page.

When you use the Process Task in the process editor, you cannot use the Public folder option
in the Select process file field because adding a public process as a dependency to the private
process is not supported.

When users use the Image element to render images, the images does not render external images
in the request view when users run their tasks.

Discovery Bot

Новые возможности

Sort for a process tile from the Processes page
You can now use the sort field to help you locate a process tile quickly. From the Processes page,
use the drop-down menu to sort on a process tile based on the process name in alphabetical order.
Alternatively, you can sort in the order of the newest process created to the oldest process and vice
versa.
Create a Discovery Bot process
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Новые возможности

Enhancements to opportunities
You can now review and analyze automatically generated (or system-generated) opportunities
immediately from the Opportunities page. Auto-generated opportunities are created when at
least two recordings are approved by the user. You can create a custom opportunity from an auto-
generated opportunity and apply the Model and Filter options to target a specific opportunity for
automation.
You can now prioritize opportunities based on a simple formula for all recordings in a process. From
the Opportunities table, you can view the cost without automation and savings for an opportunity.
The system automatically calculates the cost and potential savings for each opportunity generated.
You can customize these metrics based on your organization's model for cost and savings.
Review opportunities and convert to

Generated PDD files are available on your local server
The generated PDD file for an opportunity is now stored locally on your server for On-Premises
deployments. The existing PDD files are automatically moved to the new location and are not
deleted when a re-installation or upgrade is performed in the Control Room.

Необходимые условия для Discovery Bot

Исправления

ID обращения к облачному сервису Описание

-- Double-click, drag-drop, click and hold, and
text select are now supported when you are
recording a business process.

-- When you record a process with more than
1000 steps, the Recordings page now displays
the process without any delay. Previously, the
Recordings page took some time to load.

Ограничения

The Control Room installer for Red Hat Enterprise Linux (version 7.7 or 7.9) does not include the
Discovery Bot package.
Обходное решение. Log in to the Control Room as an admin, select Manage > Package
> Upload and upload the Discovery Bot package. The package is included in the list of default
packages.

• Cloud users: When an opportunity is created with 50 steps, the Download PDD option is
disabled and the PDD is not available for download.

• On-Premises users: When an opportunity is created with 100 steps, the Download PDD
option is disabled and the PDD is not available for download.
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IQ Bot

Новые возможности

IQ Bot standard forms
Create learning instances using the standard forms, which use an existing pretrained model and
classification for extracting a large number of data fields from structured documents that typically
have less or no variations in the layout.

Прим.:  Standard forms are currently available only as a beta feature.

Using IQ Bot for standard forms

Additional learning instances for IQ Bot Process documents action
Use the new Azure 3.2 and japanese_Tegaki learning instances for the IQ Bot Process
documents action in the IQ Bot Extraction пакет.

Использование action IQ Bot Обработка документов

Изменения

IQ Bot file paths
File locations and folder names are updated to use the new product name. Пример.
• The default installation path is changed from C:\Program Files (x86)\Automation

 Anywhere IQ Bot A2019\ to C:\Program Files (x86)\Automation 360 IQ Bot\.
• The default log path is changed from C:\Users\Public\Documents\Automation

 Anywhere IQ Bot A2019 to C:\Users\Public\Documents\Automation 360 IQBot
 Platform.

Provider column on Learning Instances page updated
The Provider column in the Learning Instances > My learning instances page is now
updated to display a list of all available Распознавание текста (OCR) engines associated with the
corresponding learning instance.

Enhancements to IQ Bot Extraction пакет
IQ Bot Extraction пакет now supports the following Распознавание текста (OCR) engines:
• Microsoft Azure Computer Vision OCR engine 3.2

This significantly improves the Распознавание текста (OCR) extraction from Chinese language
documents.

• Tegaki API Распознавание текста (OCR) engine

IQ Bot Extraction пакет

Enhancement to IQ Bot security (Service Cloud Case ID: 00677507)
You can now further improve security in IQ Bot by configuring RabbitMQ v3.8.18 communication
through a secure SSL/TLS channel. Set secureRabbitMQCommunication = true in the
system.properties file and then restart all IQ Bot services, including RabbitMQ v3.8.18. By
default, this flag is set to false.
This enhancement also fixes an issue that caused a RabbitMQ v3.8.18 security vulnerability.
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Изменения

Reuse the name of a deleted learning instance | Automation 360 IQ Bot On-Premises
While creating or editing a new learning instance, you can now reuse the name of a learning
instance that was deleted. Ensure you backup the documents in your Output folder before deleting
a learning instance. You can then clear the documents of the Output folder before creating or
editing a new learning instance with the same name.
If you have not cleared the documents from the Output folder for the deleted learning instance,
you cannot download the contents. However, you can download only the documents processed by
the new learning instance.

Support for Microsoft Azure SMB
IQ Bot now supports Microsoft Azure files storage system using the SMB (Server Message Block)
protocol. You can now also install IQ Bot using the shared folder configured with SMB and access
the output files from the same directory.

Switch between databases without re-installing IQ Bot
You can now switch between configured databases without re-installing IQ Bot using the
SwitchDBServer.bat utility.
To use this utility, perform the following steps:
1. Download and extract the SwitchDBServer.bat utility from the <IQBot installation

 Dir>\Configurations folder, and then open the command prompt in this directory.
2. Run the batch (.bat) file with an IP address or hostname of the destination DB server.

Example: SwitchDBServer 171.xx.xx.11

В приведенной ниже таблице перечислены исправления и сборки, в которых были сделаны эти
исправления. Build 9642 is the latest build for On-Premises and includes fixes from the previous build.

Исправления

Сборка ID обращения к облачному
сервису

Описание

9596 00777932, 00766332 While you update to this IQ Bot release, the
output path from the previous version is now
retained during installation.

9595 00686444 When exporting learning instances from one
environment to another, IQ Bot now updates
the visionBotId in the exported data. So
you can now edit боты in the destination
environment without any errors.

9595 -- Duplicate table row entries in the Валидатор
are now significantly reduced due to the
improved table extraction logic.

9595 00651057 IQ Bot can now connect to Control Room
Ignite cache without any errors. This fixes an
issue where all learning instances were not
displayed.
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Исправления

Сборка ID обращения к облачному
сервису

Описание

9595 00616038 When you update or restart Control Room,
error messages are no longer displayed when
you use the link or click Explore IQ Bot to
open IQ Bot.

9595 00668412, 00644948, 00717414 When you now upload a document in
production, deadlocks no longer occur in the
system and documents are correctly sent to
the Валидатор.

9595 00651572, 00650959 If no files are available in the Output
\Successful folder and you click the
Download all documents action, IQ Bot
now displays the correct error message.

9595 -- Documents in Chinese (Simplified) language
are now processed successfully without any
issues.

9595 -- If you add a blocked library to a custom
Python logic and click Test Run for any field,
an error message is no longer displayed on
the Designer page.

9595 -- The Enterprise 11 IQ Bot command can now
be migrated to the Upload Documents
action in Automation 360 IQ Bot. Therefore,
you no longer have to manually create боты
when you migrate the learning instances.

Ограничения

IQ Bot Cloud: If you do not access IQ Bot within the configured Ideal time out value set on the
IQ Bot server:
• Отображается сообщение о необходимости перезапустить IQ Bot.
• При перезагрузке сервера происходит сбой Боты, которые используют API IQ Bot.

Обновите веб-страницу IQ Bot через некоторое время (более 5 минут), чтобы войти в IQ Bot.

When you create a learning instance, if the PDF that you upload contains small fonts, the document
is classified as an image. If you use the PDFBox Распознавание текста (OCR) to create a learning
instance for a multipage document, the segments are not displayed.
Обходное решение. Turn off the PDFBox Распознавание текста (OCR).

For a standard forms learning instance, when you try to download output files and at the same time
send frequent API requests to that database, the system might stop responding.
Рекомендации: When using the standard forms learning instance, wait for the files to be
downloaded. After the download, ensure you allow some time (> 60 seconds) between the API
requests.
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Ограничения

If an incorrect configuration is used to create the providerVersion file of a standard forms
learning instance, an error message is displayed when you move this learning instance to
production.

Прим.:  Ensure you use valid configurations.

If you use a бот associated with a standard forms learning instance to upload a large number of
documents, some of the documents are not processed.
Обходное решение. Because this issue might be caused due to a timeout, try to upload the
documents after some time.

If you have used an earlier version of IQ Bot (11.x) to move documents to the Validator, you
cannot download these documents when you migrate to this Automation 360 IQ Bot version.
Обходное решение. If you are migrate to this version, ensure you clear all the documents in
Валидатор.

When you use the Download all documents or Upload Document actions from the IQ Bot
пакет, the upload and download can fail as the proxy settings specified in the Control Room are not
used.

If you manually delete any .csv file from the Success folder, other files in the folder might not be
downloaded when you use the Download option.
Ensure you do not manually delete any files from the Success folder.

Only SQL authentication is supported when you use the Migration Assistant tool to migrate from IQ
Bot 11.x to Automation 360 IQ Bot.

Если у вас есть документ с большим количеством страниц (более 100), то при нажатии
кнопки Посмотреть результаты извлечения для существующего обучаемого экземпляра
периодически отображается сообщение об ошибке.

The unclassified documents count in Staging results and Production results in the Summary
tab of a learning instance might be displayed incorrectly.

На экране Валидатор, если для обновления поля, к которому были применены проверки,
используются неверные значения, предупреждение не отображается, если это поле
неактивно.

If any of the available number fields include parenthesis or (), the selected system identified region
(SIR) on the document panel changes to a hyphen (-) when you click the extracted value.

If you use the name of a deleted learning instance when creating a new learning instance, both the
instances are listed in the Learning instance name drop-down menu of the Upload document
action when a бот is created.
Обходное решение. Click the new learning instance to remove the old learning instance from
the list.

If you use the Tesseract4 OCR during IQ Bot Extraction пакет updates, there is a delay in the
document processing time and throughput results.

For a learning instance created with standard forms, if the extraction is not successful for the Field
options > Optional field, the value set in Default value is not assigned to that form field.
Обходное решение. Use Python script from the Logic tab to set the value that must be
assigned as the Default field.
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Ограничения

(ID обращения к облачному сервису: 00601790) For documents processed using the IQ Bot
Extraction пакет, document details such as Documents processed and Pages uploaded are not
displayed correctly in the Dashboard page.

As the Preview2 version of the Microsoft Azure 3.2 is deprecated, if you have used the Microsoft
Azure 3.2-Preview2 Распознавание текста (OCR) engine to create a learning instance, the
documents will be unclassified.
Обходное решение. Ensure that you replace all occurrences of Microsoft Azure 3.2-Preview2
with Microsoft Azure 3.2:
• In Azure3OCREngineSettings.json file, change Version: v3.2-preview.2 to Version:

v3.2. You can then update the Распознавание текста (OCR) engine version by uploading this
file to database using API
How to change OCR Settings in IQ Bot (A-People login required)

• In the IQ Bot Installation > Configurations folder, update
Azure3ContainerOCREngineSettings with Microsoft Azure 3.2. This is for the
containerized deployment of Microsoft Azure 3.2 Распознавание текста (OCR) engine.

(ID обращения к облачному сервису: 00799842) When you process vector-based PDF documents
in IQ Bot, the OCR results are sometimes inaccurate. For instance, in some cases, spaces between
words are missed in the extracted data.This might happen because of reasons related to the
document that you uploaded or the tool that you used to generate the PDF file.
Обходное решение. To process your vector-based PDF document successfully, perform either of
the following steps:
1. Convert your vector-based PDF document again to a vector-based PDF document by using a

tools such as Adobe Acrobat.
2. Convert your vector-based PDF documents to a raster file format, such as TIFF.

Важное замечание:  Для получения информации о пакетах, поддерживаемых этим выпуском, см.
раздел View пакет versions available in the Control Room.

Enterprise A2019.20 Release Notes
Дата выпуска:20 апреля 2021 года
Review what's new and changed, and the fixes and limitations in the Enterprise A2019.20 release. Сборка
8846 is for Cloud and Сборка 8815 is for On-Premises. IQ Bot A2019 is on Сборка 8815.

Важное замечание:  We have updated the Cloud build to include the following fixes:
• Migrated боты failing to execute due to preprocessing error (Service Cloud case ID 00760877,

00761211)
• Unable to deploy боты because the resource path exceeds the maximum length supported by Microsoft

(Service Cloud case ID 00764731, 00763373, 00765172, 763334)

• Миграция
11.x и 10.x | Только 11.x

© 2023 Automation Anywhere. All rights reserved.     418

https://apeople.automationanywhere.com/s/article/How-to-change-OCR-Settings-in-IQBot


    Automation Anywhere - Learn

• Enterprise A2019

Новые возможности |  Изменения | Исправления | Ограничения
• AARI

Новые возможности |  Изменения | Исправления | Ограничения
• Discovery Bot

Новые возможности |  Изменения | Исправления | Ограничения
• IQ Bot

Новые возможности |  Изменения | Исправления | Ограничения
• Bot Insight

Новые возможности

Обновление до этого выпуска
You can update to this release from the previous three releases (that is, from n−3 releases, where n refers
to the latest release). The following builds are certified for update to this release:
• Сборка 8147 (v.19)
• Сборка 7560 (v.18)
• Сборка 7103 (v.17)

For details on how to update, see Обновление до последней версии Automation 360.

Recommendation:  If you are not on an n−3 release, update to one of the three certified releases
before updating to this release.

Важное замечание:  This release includes a required update to your . Ensure that you complete the
update to continue with your automation activities when upgrading from a previous release to this release.

Автоматическое обновление Bot Agent | Обновление Bot Agent вручную

To verify which  version is compatible with this release, see Compatibility with release builds.

Особенности миграции

Enterprise 11 and Enterprise 10 features

Select folders for migration (Service Cloud case ID: 00689307)
In the Bot Migration Wizard, you can now select folders that contain боты (TaskBots and MetaBots)
that you want to migrate to Enterprise A2019. As a result, you no longer have to migrate individual
боты from that folder.

Migrate MetaBots with screens
Migrate MetaBots that contain screens as assets. You can migrate screens based on HTML, MSAA,
Java, .Net technologies and use credential variables.
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Enterprise 11 and Enterprise 10 features

Migrate боты with the following attributes
• Боты that contain the IF > Logic successful or IF > Logic unsuccessful command and

these commands return a variable as output
• Боты that contain the Выполнить задачу command with the Repeat until I stop it option to

the Run action in the TaskBot пакет
• Боты that use the $Clipboard$ system variable as input and output variables to pass the value to

the MetaBot logic

Только для Enterprise 11

Migrate боты that use SAP BAPI to automate SAP-related tasks
Migrate боты that use SAP BAPI to automate the SAP-related tasks. The SAP commands are
migrated to equivalent actions of the SAP BAPI пакет, and the username, password, and hostname
attributes used to connect to the SAP server in the Enterprise 11 боты are migrated as credential
variables in Enterprise A2019.

Retain legacy behavior of $Excel Cell Row$ system variable
Use the Use "Excel Cell Row" legacy behavior option in the Bot Migration Wizard to retain the
legacy behavior of the $Excel Cell Row$ system variable used in боты created in versions earlier
than Version 11.3.1 after they are migrated to Enterprise A2019.

Миграция боты с указанными ниже атрибутами.
• Боты that use the Delete or Get All Messages command to delete or download attachment

from all emails that use Exchange Web Services (EWS) using OAuth authentication.
• Боты that contain objects captured using the Object Cloning command that are based on Firefox

and Silverlight technologies
• Боты that use the Modify user command with the Update Account Options and the

Change Password option in the Active Directory command
• Боты that use the Create user option in the Active Directory command
• Боты that use the Операция переменной command and the Decimal configuration option is

selected
• Боты that use the $AATaskExecutor$ system variable
• Боты from Version 11.3.5 or later that use the Get Single Cell command with the Specific

cell and Get Cell Value options selected to retrieve value from a cell in a Microsoft Excel file.
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Enterprise A2019

Новые возможности

Support for IPv6 addresses
You can install Enterprise A2019 in distributed load balancer cluster mode in an IPv6 network to
comply with your organization's infrastructure and information security requirements.
The following are not supported:
• Geo location is not available for IPv6 addresses.
• Link-local addresses for IPv6 addresses are removed from the Enterprise A2019 installer's IPv6

list.

Настроить IP-кластер

Switch device registration between Control Room instances
You can now switch your device registration between multiple instances of the Control Room
without reinstalling the Bot Agent. This setting is applicable to single user devices installed at the
system or user level.

Переключение регистрации устройства между экземплярами Control Room | Switch Bot Agent to a
different Control Room

New permission to attest device user name (Service Cloud case ID: 00576058)
Use the new permission to assign a default device to a user name to bypass credential validation
when you deploy a бот on unattended Bot Runner. The permission is applicable to default device
users with an unlocked and active user session.

Разрешения на использование для функции

Resource threshold settings to optimize бот deployments
Configure resource threshold settings in the Control Room so that the system deploys the next
бот only when the system resources on the device are within the specified thresholds. Specify the
settings at the Control Room level for all devices, and customize these settings at each device level.
Manage device settings

Reduce бот startup time
You can now reduce the бот startup time using settings in the Control Room to preload the most
frequently used packages in the automation on all user devices when they connect to the Control
Room.
Automatic пакет updates for Cloud Control Room

Express queue in workload automation
You can now quickly create workload automation queues with default parameters in the Control
Room by using the Create express queue option in the Queues page.
Create express queues
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Новые возможности

Group filters for Active Directory users
You can provide additional filters for the Users directory as part of the um.properties file. As
a result, you can filter the security groups that are in the Users directory for role mapping in the
Control Room.
Manage Active Directory role mapping

Automate SAP-related tasks using SAP BAPI
Use the actions available in the SAP BAPI пакет to automate SAP-related tasks using SAP BAPI.

пакет SAP BAPI

Default names for output variables
When you configure an output variable for the following пакеты, the Control Room shows a
descriptive default variable name. If you create several output variables, subsequent variable names
are appended with a -1, -2, -3, and so on to avoid duplication.
• Браузер
• CSV/TXT
• Эл. почта
• Расширенный Excel
• JavaScript
• Цикл
• Средство записи
• VBScript
• Окно

PDF split with blank pages supports scanned image documents (Service Cloud case ID:
00683923)
Use the PDF Split action to separate a blank page from pages with scanned images. With pixel-
based split, you can now use Split document to split a PDF with blank page separators for
scanned (image-based) documents.

SMTP port range expanded to include ports 1 through 65535
The Эл. почта пакет now supports ports in the range of 1 through 65535 for the SMTP server. You
can use the Send email action by configuring the SMTP port in this range.

New actions in the Active Directory пакет
• Update account options: Sets account attributes for the user.
• Change user password: Use this option to change a user's password.

User account operations

Enhancement to Create user action in Active Directory пакет
You can now use the Create user action to create an Active Directory user with password.
Using the Create user action
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Новые возможности

Universal Recorder expanded support and new features
Use the Universal Recorder to perform the following:
• Automate clicks and data retrieval in drop-down lists and combo boxes in Oracle EBS

applications such as Compass.
• Link an object that the бот cannot reliably identify to a nearby object (such as a link or button)

that is easier for the бот to find. Use this feature in MSAA, UI Automation, or Java applications.

Support for new languages in variable names
You can now use Czech, Danish, Dutch, Finnish, French, German, Hungarian, Italian, Norwegian,
Polish, Portuguese, Romanian, Spanish, and Swedish characters in variable names.
Unicode range supported in variables

Search and add child бот in the parent бот
Search for a child бот in the public and private workspaces so that you can add it in the parent бот.
You can search for the child бот from the Bot editor and the Run action of the TaskBot пакет.
Using the Run action | Bot editor for creating боты

Obtain information about user that deployed the бот
Use the AATaskInvoker system variable to return the username, first name, last name, and email
of the user that ran or scheduled the бот. If the бот is deployed to an attended Bot Runner, this
variable returns information about the logged-in user. If the бот is deployed by a trigger, this
variable returns information about the user who set the trigger.
System settings and parameters

Git restoration enhancements
• If your database is deleted or corrupted, as an administrator you can now restore files from the

Git repository to a repository that is not fully empty.
• You can also overwrite or skip the files if you have duplicate files in the Git repository.
• If you are restoring files in an empty repository, you can choose to use either your existing

credentials (configured with Control Room) or the credentials of any other repository.

Restore боты from Git repository

View version history of TaskBots
You can now view the version history of your TaskBots to identify relevant changes performed by
other users to your TaskBots during a specific date and time along with the check-in messages.
View TaskBot version history

External key vault support
Use external key vaults to securely store and retrieve credentials using a third-party key manager
such as CyberArk and AWS Secrets Manager. External Key Vault support for AWS Secrets Manager
and CyberArk for Bootstrap (database credentials,) and System (Service account credentials, Active
Directory service account credentials, and SMTP credentials).
Integrate external key vaults
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Новые возможности

New condition in If пакет (Service Cloud case ID: 00536088, 00690073,00717514, 00737243,
00702383)
Use the new Window with same title does not exist or Window with same title exist
condition available in the If пакет to verify whether a window with the same title exists or whether
the window title has changed.

Если пакет

Google пакеты are now generally available
Google Календарь, Google Диск, and Google Таблицы пакеты are now generally available in
Enterprise A2019, with a major change to the authentication method:
• Each Google пакет contains a Connect action to authenticate your account before adding other

actions from that пакет to your automation. This action replaces the deprecated OAuth action
from the G-Apps пакет.

• Each Google пакет contains a Disconnect action to terminate the connection.

Using the Connect action for Google packages

Изменения

Боты wait for Internet Explorer to fully render in Мышь пакет
Боты (including боты migrated from Enterprise 11) that use the Мышь пакет now wait for the
Internet Explorer to finish loading the page before executing the Click action. This prevents the
боты from failing while the page is loading.

Interface change in the Edit variable window
When editing a variable, if you deselect the Use as input, Use as output, or Constant (read-
only) check box, a message now informs you of the impact of this change and requests you to
confirm this update.

Enhancement to audit log entries (Service Cloud case ID: 00656155)
The audit log entries are now enhanced to display the Item Name and Event Type for import,
export, check-in, and check-out requests.

The .atmx file not downloaded during migration
The migration process does not download the .atmx file if the associated бот is used as a child бот
in the parent бот. The Download CR file action from the Файл пакет is no longer added in the
migrated бот to download the depended бот (.atmx) file during migration.

Option to either upgrade Средство записи пакет version or downgrade to older Google
Chrome extension
Боты that use the Средство записи пакет version 2.0.5 or older to automate in the Google Chrome
browser, now need to be updated to use a Средство записи пакет version that is newer than
2.0.5. This is only necessary for Bot Runner devices that have the new Google Chrome extension
(ID:kammdlphdfejlopponbapgpbgakimokm) installed, and have not previously run боты that use
the Средство записи пакет version 2.0.5 or older.
If you do not want to upgrade the Средство записи пакет, you can manually install the old Google
Chrome extension. См. раздел Google Chrome extension troubleshooting.
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The following tables lists the fixes and the builds in which they were fixed. Сборка 8846 is the latest build
for Cloud and includes fixes from the previous builds. On-Premises is on Сборка 8815.

Сборка 8846

ID обращения к облачному сервису Описание

00764731, 00763373, 00765172, 763334 You can now deploy боты and dependent files
stored in a repository with a file path that exceeds
the maximum supported character length (256
characters) for your Windows operating system.

00714248 Only those Bot Runner and Bot Creator expressly
configured as credential vault consumers for a given
бот can use that бот.

00751728 When you migrate Enterprise 11 боты that use the
Операция строки command with the space character
as a delimiter, the extracted value now retains the
space and works properly. Previously, after migration,
the space from the Операция строки command was
removed.

00760877, 00761211 Боты that are migrated, modified, and scheduled now
successfully deploy without a preprocessing error.
Previously, migrated боты failed to execute due to
the following preprocessing error: Attribute type
ANY is not supported.

Сборка 8840

ID обращения к облачному сервису Описание

00747869, 00750571, 0744918 When you create a bot using a loop with the
Recorder Capture action to perform operations on
the Chrome browser, the bot now executes without
any disruption. Previously, the bot failed to run and
displayed an error.

00733635, 00743082, 00750865 When you run a bot that contains the Excel Advanced
> Find action, the found cell is now active and
subsequent actions can perform operations on that
active cell.

00723075, 00717920 When a bot encounters a workbook that contains
links to cells in other workbooks, the system
suppresses the Excel pop-up message so that the bot
can run without interruption.

00746651, 00757879 After migrating bots, you can successfully run the
bots without any preprocessing error. Previously,
using variables inside brackets failed to process the
task.

00742159, 00743092 The Excel Advanced Set cell and Delete cell actions
now select the correct cells when the cell address
column name contains more than one letter.
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Сборка 8840

ID обращения к облачному сервису Описание

00743636 The Excel Advanced Set cell, Delete cell, and Go to
cell actions now support all ranges. Previously, the
actions encountered errors with ranges greater than
AB1:AB100.

00726030 Боты can now use the Средство записи to capture
objects that contain characters that are not valid in
XML.

Сборка 8815

ID обращения к облачному сервису Описание

00750668 A workload бот is no longer stuck in a queue, and the
device does not display a Pick up at run time
status.

00733227 Control Room database tables are now created when
you use the restored 11.x database while installing
Enterprise A2019.

00733720 Bot Migration Wizard no longer encounters an error
when processing a large bot for migration. Previously,
this issue was encountered when a large bot was
downloaded to the Bot Runner device for migration
from the Control Room and the connection between
the Bot Runner device and Control Room was reset.

-- Bot Scanner is now updated to include scenarios that
were previously failing after migration. As a result,
some боты might be moved from the list of боты that
can be migrated to the list of боты that cannot be
migrated in the output report. This can decrease the
number of боты that can be migrated to Enterprise
A2019.

00703679, 00711398, 00729399 Enterprise 11 or Enterprise 10 боты that use the
string variable or an object captured from Internet
Explorer whose property is null or empty no longer
encounters an error after these боты are migrated.

00667326 Bot Scanner no longer becomes unresponsive when
scanning боты for any of the following reasons:
• Scanning a corrupted .atmx file of a бот
• Боты that contains the Если, IF/ELSE, or Цикл

command and that command is commented out
• Бот that contains an object that is captured

using the Object Cloning command using the
Coordinate play mode and the Click action is
performed on that object
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00731068, 00737025 An error is no longer encountered when you run a
бот that contains multiple variables that return a
number value in the same command after that бот is
migrated.

00720261 An error is no longer encountered when you run a
migrated бот that contains a special character.

00713303 In a migrated бот that uses the Выполнить задачу
command, when you run a subtask within the
main task and the subtask name contains Unicode
characters, the бот now executes successfully
without any error. Previously, the бот failed and
displayed an error message.

00691133 You can now successfully delete migrated боты in
your private workspace without encountering any
issue. Previously, an error message was displayed
when a migrated бот was deleted in the private
workspace.

00736166 Previously, when the migration process was
initiated, the process sometimes remained in the In
progress status in the Bot Migration Wizard. Now
the process starts running.

00730131 Боты that use the Run Script command with the
$Clipboard$ system variable as an input or output
variable no longer encounter errors when you run
these боты after they are migrated to Enterprise
A2019.

00726833 Enterprise 11 Work Items and queues that are
associated with боты that use the Операция
переменной command no longer encounter an
error after the first item in the queue is processed
successfully after migration to Enterprise A2019.

-- Bot Scanner no longer encounters an error when
scanning MetaBots that contain the Object Cloning
command that is commented out and the MetaBot is
trying to find the play mode from those commented
out commands.

00716557 An error is no longer encountered when you run a
MetaBot in Enterprise A2019 that was created in
Enterprise 10, migrated to Enterprise 11, and then
migrated to Enterprise A2019.

00710569 When you migrate a MetaBot that contains screens
as assets from Enterprise 11 to Enterprise A2019,
Japanese characters in the object properties are now
displayed correctly in the migrated боты. Previously,
the Japanese characters in the object properties were
garbled in the migrated боты.
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00702262 The Historical activity page now shows a detailed
error message that specifies the cause of the error
and the line where the error is encountered for боты
that are migrated from Enterprise 11 and use the
Обработка ошибок command.

00703513, 00708988 Parent боты that use the Run action of the TaskBot
пакет with the Upon error, start next repetition
option selected no longer encounter an error if their
child боты encounter an error at runtime and do
not return the output variable to the parent бот.
Previously, parent боты encountered an error if the
child боты did not return the output variable to the
parent боты because the child боты encountered an
error during runtime.

00702601 A бот that uses an array variable that contains a
system variable and which returns an integer no
longer encounters an error after that бот is migrated.

00707801 You can now migrate an Enterprise 11 бот that
contains Мышь Click to capture the coordinates
of a maximized window. Previously, the бот with a
Мышь Click encountered an issue during migration
because the window left and top parameters were set
to negative values for maximized windows.

00710315, 00728228, 00729082, 00744242 Migrated боты that use the Object Cloning command
with legacy technology to capture objects with
multiple lines of text now work properly, without any
issues.

00716650 When you migrate an Enterprise 11 бот that contains
an Excel command with two Excel sessions in it,
the Get column name or Get row number
actions now displays the correct values in the output.
Previously, the actions set the wrong session values
in the migrated бот if it contained two Excel sessions.

00711148 Enterprise A2019 installation no longer fails if there
is a space in the data and log path (for example, D:
\Automation Anywhere\ProgramData). And,
the following error message is no longer displayed:
Сбой при создании таблиц базы данных
Control Room.

00708902 You can now use the Google Drive пакет to upload
files in the Google Shared Drive. Use only the
Folder ID option to upload files to a shared folder
in the drive and enter the ID of the shared folder.
Previously, an error occurred when a user tried to
upload a file in the shared folder in the Google Drive.
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00735479 When you create a бот that has a dependency with
a long repository path that exceeds the maximum
limit of 256 characters and when you run the бот
on the Bot Runner machine, the бот now displays a
message, prompting you to reduce the length of the
file path. Previously, the бот execution failed without
any message providing the reason for the failure.

00727406 You can now successfully send an email in HTML
format with an HTML attachment using the Email
server. Previously, when an email was sent in HTML
format along with an attached HTML file, the email
body content and the content of the attached file
were merged. As a result, only the attachment was
seen in the mail without the body content.

00707734 In the Интеграция приложений пакет, when you
use the Capture text of window action in a
Japanese browser, the window title now displays
properly for Japanese language. Previously, the
output was not displayed correctly in the Japanese
text format.

00699149,00707670 You can now use the Unzip action of the Папка
пакет and execute your боты on a Windows 10
server. Now, if two Windows users with different
device credentials try to deploy a бот on the same
machine, the deployment does not fail. Previously, if
a user deployed the бот on the same machine with a
different user profile, the бот failed to execute.

00695224, 00730472, 00739431 When you use the Find Image in a Window action
in the Распознавание изображений пакет, image
files are now deleted from the Temp location and
storage space is freed after бот execution. Previously,
the image files were not deleted from the Temp
location and as a result disk storage ran out of space.

00709162 The CSV/TXT Open action now works without
encountering any issue even if there are blank values
in the last row of the .txt file. Previously, if there
were blank values in the last row of the file, the бот
encountered an issue.

00711124 In the Эл. почта пакет, when you use the Connect
action, add a loop, and select For each in mail box
to read emails as the Iterator option, a new line
is no longer deleted and correctly displays the email
content. Previously, the new lines were deleted when
the mail was sent and received in plain text format.
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00673049 In the SAP пакет, if an error is encountered when
the Connect action is used to connect with a SAP
system, the error is now captured in the Try and
Catch blocks. Previously, the connection issue was
not captured in the Try and Catch blocks in the
action.

00697215 A бот now executes successfully when you use the
Throw action with an expression. Previously, when
an expression such as $number.ToString$ was
used in the Exception message field of the Throw
action, the бот encountered a preprocessing error.

00714260 Runtime errors are no longer displayed when you use
the following:
• A MetaBot with run DLL migration function that

takes more than one parameter type as Array or
any type other than String

• A TaskBot with run logic calling a child бот that
takes more than one input parameter of type
Array, which is mapped to a List variable in the
parent бот run logic migration function

00704547 The Pause action of the TaskBot пакет now works
properly when you use it as the last task in the
бот. Previously, the бот did not wait for the task to
complete if the Pause action was used as last task in
the бот.

00675344 A TaskBot now performs better when you use the
Эмулятор терминала Send text and Send key
actions to execute a бот. Previously, the TaskBot took
a long time to complete the execution.

00699650,00716648 When you use Распознавание изображений actions
to execute a бот and if the бот fails during execution,
the captured source and target images are stored
in C:\ProgramData\AutomationAnywhere
\BotRunner\Logs\IR with a maximum of 10
source and target image pairs. Now, when the
maximum limit is reached, the oldest image pairs are
overwritten with new images. Previously, the image
logs were not overwritten.

00716817 A бот now executes successfully when you use the
PDF Extract text action to extract structured text
from PDF files. Previously, бот execution failed to
extract structured text if it contained Thai characters.

00717204 You can now use a credential from the Credential
Vault in the URI field of the Веб-служба REST
actions.
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00682726, 00678580, 00695359, 00684985 You can now use the Universal Recorder to automate
in Oracle Fusion Middleware applications. Previously,
an issue with the Java API caused the Recorder
to select the entire window instead of the specific
object.

00693770 Fixed an issue where numbers extracted from an SQL
database to a data table variable were automatically
converted to scientific notation.

00669959 You can now select the same start date and end date
when you schedule боты with the Run repeatedly
option (Activity > Scheduled > Schedule bot) in
the Control Room.

00702841, 00700915 Disconnected devices are now displayed in the
Control Room (Devices > My Devices) when you
filter the devices list by Status as Disconnected.

00707318, 00711529 Work items in an active queue are now processed
and you no longer have to delete the active queue
and create another queue after you upgrade from a
previous release to this release.

00705046 Боты that include embedded dependent files instead
of a zipped folder are no longer queued intermittently
for deployment on Bot Runner devices.

-- Disabled tenant IDs or removed tenants that are
later reused on the same deployment with a different
tenant might produce a licensing error. This conflict
is now removed and deboarded tenants in later reuse
no longer generate the error.

00685926 When you import an exported бот into the private
workspace and check in the imported бот, the бот
is now checked in successfully without any issues.
Previously, the check-in failed due to a metadata
validation error.

00682025 When a бот or a file is modified in the public
workspace, the cloned dependent file in the private
workspace now reflects the changes and the
бот executes successfully. Previously, the cloned
dependent file did not reflect the changes and the
бот execution failed.

00726018 The Google Drive Upload file action now uploads
files to subfolders.

00715080, 00731152 You can now perform concurrent unattended бот
deployment on a multi-user device with multiple user
sessions running simultaneously.

-- A non-admin Bot Agent user now remains connected
to the Control Room and is not disconnected
frequently.
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00709737 Действия in the Google Sheets пакет now support
worksheets that contain empty cells.

00710354 A hibernate exception error is no longer displayed
when you log in to the Control Room as an admin
user.

00732178 You can now check out боты from folders with similar
names but in different letter cases and edit the боты
in your private workspace in the Control Room.
For example, if there is a folder named
Automation1 in the public workspace and a
folder named automation1 folder in the private
workspace, you can now check out боты from the
Automation1 folder in the public workspace.

-- Боты are now deployed on a multi-user device in a
non-admin user session when another admin user
session is also active on the device if auto-login
setting in the Control Room is set to lock the session
after the бот finishes executing from an existing
unlocked session.

00719407 During a cluster installation of Enterprise A2019 on
Red Hat Enterprise Linux, the installer now uses the
same user ID across all cluster nodes.

00703325 The log file permission for an Control Room installed
on Linux now maps to the crkernel user. Previously, it
was mapped to the root user.

-- When you access the Control Room with the Login
with Windows option selected, you must now enter
the FQDN to log in successfully.

00732141, 00722919,00743006 When you preload a пакет, after the download is
complete, the completion status updates in the
Activity > Historical activity page and the
pending record is no longer displayed in the Activity
> In progress page.

00731376 When you migrate MetaBot logic, if there is case
mismatch in the variable name and the mapping
variable, variables are no longer created twice. As a
result, a preprocessing error does not appear when
you execute the task.

Now, the migration of run logic with CV variables is
supported.

Now, when using the Date system variable in the
File folders command, a migrated bot is no longer
failing.
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When migrating боты (v11.x to A2019) with OC
properties more than 64KB, such properties will be
truncated and the bot will be migrated.

В приведенной ниже таблице перечислены исправления и сборки, в которых были сделаны эти
исправления. Сборка 8846 is the latest build for Cloud and includes fixes from the previous builds. On-
Premises is on Сборка 8815.

Исправления

Сборка ID обращения
к облачному
сервису

Описание

8846 00764731,
00763373,
00765172,
763334

You can now deploy боты and dependent files stored in a
repository with a file path that exceeds the maximum supported
character length (256 characters) for your Windows operating
system.

8846 00714248 Only those Bot Runner and Bot Creator expressly configured as
credential vault consumers for a given бот can use that бот.

8846 00751728 When you migrate Enterprise 11 боты that use the Операция
строки command with the space character as a delimiter, the
extracted value now retains the space and works properly.
Previously, after migration, the space from the Операция строки
command was removed.

8846 00760877,
00761211

Боты that are migrated, modified, and scheduled now
successfully deploy without a preprocessing error. Previously,
migrated боты failed to execute due to the following
preprocessing error: Attribute type ANY is not
supported.

8840 00747869,
00750571,
0744918

When you create a bot using a loop with the Recorder Capture
action to perform operations on the Chrome browser, the bot
now executes without any disruption. Previously, the bot failed to
run and displayed an error.

8840 00733635,
00743082,
00750865

When you run a bot that contains the Excel Advanced > Find
action, the found cell is now active and subsequent actions can
perform operations on that active cell.

8840 00723075,
00717920

When a bot encounters a workbook that contains links to cells
in other workbooks, the system suppresses the Excel pop-up
message so that the bot can run without interruption.

8840 00746651,
00757879

After migrating bots, you can successfully run the bots without
any preprocessing error. Previously, using variables inside
brackets failed to process the task.

8840 00742159,
00743092

The Excel Advanced Set cell and Delete cell actions now select
the correct cells when the cell address column name contains
more than one letter.
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8840 00743636 The Excel Advanced Set cell, Delete cell, and Go to cell actions
now support all ranges. Previously, the actions encountered
errors with ranges greater than AB1:AB100.

8815 00750668 A workload бот is no longer stuck in a queue, and the device
does not display a Pick up at run time status.

8815 00733227 Control Room database tables are now created when you use the
restored 11.x database while installing Enterprise A2019.

8815 00733720 Bot Migration Wizard no longer encounters an error when
processing a large bot for migration. Previously, this issue was
encountered when a large bot was downloaded to the Bot
Runner device for migration from the Control Room and the
connection between the Bot Runner device and Control Room
was reset.

8815 -- Bot Scanner is now updated to include scenarios that were
previously failing after migration. As a result, some боты might
be moved from the list of боты that can be migrated to the list
of боты that cannot be migrated in the output report. This can
decrease the number of боты that can be migrated to Enterprise
A2019.

8815 00703679,
00711398,
00729399

Enterprise 11 or Enterprise 10 боты that use the string variable
or an object captured from Internet Explorer whose property is
null or empty no longer encounters an error after these боты are
migrated.

8815 00667326 Bot Scanner no longer becomes unresponsive when scanning
боты for any of the following reasons:
• Scanning a corrupted .atmx file of a бот
• Боты that contains the Если, IF/ELSE, or Цикл command and

that command is commented out
• Бот that contains an object that is captured using the Object

Cloning command using the Coordinate play mode and the
Click action is performed on that object

8815 00731068,
00737025

An error is no longer encountered when you run a бот that
contains multiple variables that return a number value in the
same command after that бот is migrated.

8815 00720261 An error is no longer encountered when you run a migrated бот
that contains a special character.

8815 00713303 In a migrated бот that uses the Выполнить задачу command,
when you run a subtask within the main task and the subtask
name contains Unicode characters, the бот now executes
successfully without any error. Previously, the бот failed and
displayed an error message.
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8815 00691133 You can now successfully delete migrated боты in your private
workspace without encountering any issue. Previously, an error
message was displayed when a migrated бот was deleted in the
private workspace.

8815 00736166 Previously, when the migration process was initiated, the process
sometimes remained in the In progress status in the Bot
Migration Wizard. Now the process starts running.

8815 00730131 Боты that use the Run Script command with the $Clipboard
$ system variable as an input or output variable no longer
encounter errors when you run these боты after they are
migrated to Enterprise A2019.

8815 00726833 Enterprise 11 Work Items and queues that are associated with
боты that use the Операция переменной command no longer
encounter an error after the first item in the queue is processed
successfully after migration to Enterprise A2019.

8815 -- Bot Scanner no longer encounters an error when scanning
MetaBots that contain the Object Cloning command that is
commented out and the MetaBot is trying to find the play mode
from those commented out commands.

8815 00716557 An error is no longer encountered when you run a MetaBot in
Enterprise A2019 that was created in Enterprise 10, migrated to
Enterprise 11, and then migrated to Enterprise A2019.

8815 00710569 When you migrate a MetaBot that contains screens as assets
from Enterprise 11 to Enterprise A2019, Japanese characters
in the object properties are now displayed correctly in the
migrated боты. Previously, the Japanese characters in the object
properties were garbled in the migrated боты.

8815 00702262 The Historical activity page now shows a detailed error
message that specifies the cause of the error and the line
where the error is encountered for боты that are migrated from
Enterprise 11 and use the Обработка ошибок command.

8815 00703513,
00708988

Parent боты that use the Run action of the TaskBot пакет with
the Upon error, start next repetition option selected no
longer encounter an error if their child боты encounter an error
at runtime and do not return the output variable to the parent
бот. Previously, parent боты encountered an error if the child
боты did not return the output variable to the parent боты
because the child боты encountered an error during runtime.

8815 00702601 A бот that uses an array variable that contains a system variable
and which returns an integer no longer encounters an error after
that бот is migrated.
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8815 00707801 You can now migrate an Enterprise 11 бот that contains Мышь
Click to capture the coordinates of a maximized window.
Previously, the бот with a Мышь Click encountered an issue
during migration because the window left and top parameters
were set to negative values for maximized windows.

8815 00710315,
00728228,
00729082,
00744242

Migrated боты that use the Object Cloning command with legacy
technology to capture objects with multiple lines of text now
work properly, without any issues.

8815 00716650 When you migrate an Enterprise 11 бот that contains an Excel
command with two Excel sessions in it, the Get column name
or Get row number actions now displays the correct values in
the output. Previously, the actions set the wrong session values
in the migrated бот if it contained two Excel sessions.

8815 00711148 Enterprise A2019 installation no longer fails if there is a space
in the data and log path (for example, D:\Automation
 Anywhere\ProgramData). And, the following error message
is no longer displayed: Сбой при создании таблиц базы
данных Control Room.

8815 00708902 You can now use the Google Drive пакет to upload files in the
Google Shared Drive. Use only the Folder ID option to upload
files to a shared folder in the drive and enter the ID of the
shared folder. Previously, an error occurred when a user tried to
upload a file in the shared folder in the Google Drive.

8815 00735479 When you create a бот that has a dependency with a long
repository path that exceeds the maximum limit of 256
characters and when you run the бот on the Bot Runner
machine, the бот now displays a message, prompting you to
reduce the length of the file path. Previously, the бот execution
failed without any message providing the reason for the failure.

8815 00727406 You can now successfully send an email in HTML format with an
HTML attachment using the Email server. Previously, when an
email was sent in HTML format along with an attached HTML file,
the email body content and the content of the attached file were
merged. As a result, only the attachment was seen in the mail
without the body content.

8815 00707734 In the Интеграция приложений пакет, when you use the
Capture text of window action in a Japanese browser, the
window title now displays properly for Japanese language.
Previously, the output was not displayed correctly in the
Japanese text format.
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8815 00699149,00707670You can now use the Unzip action of the Папка пакет and
execute your боты on a Windows 10 server. Now, if two Windows
users with different device credentials try to deploy a бот on
the same machine, the deployment does not fail. Previously, if a
user deployed the бот on the same machine with a different user
profile, the бот failed to execute.

8815 00695224,
00730472,
00739431

When you use the Find Image in a Window action in the
Распознавание изображений пакет, image files are now
deleted from the Temp location and storage space is freed after
бот execution. Previously, the image files were not deleted from
the Temp location and as a result disk storage ran out of space.

8815 00709162 The CSV/TXT Open action now works without encountering any
issue even if there are blank values in the last row of the .txt
file. Previously, if there were blank values in the last row of the
file, the бот encountered an issue.

8815 00711124 In the Эл. почта пакет, when you use the Connect action, add
a loop, and select For each in mail box to read emails as the
Iterator option, a new line is no longer deleted and correctly
displays the email content. Previously, the new lines were deleted
when the mail was sent and received in plain text format.

8815 00673049 In the SAP пакет, if an error is encountered when the Connect
action is used to connect with a SAP system, the error is now
captured in the Try and Catch blocks. Previously, the connection
issue was not captured in the Try and Catch blocks in the
action.

8815 00697215 A бот now executes successfully when you use the Throw action
with an expression. Previously, when an expression such as
$number.ToString$ was used in the Exception message
field of the Throw action, the бот encountered a preprocessing
error.

8815 00714260 Runtime errors are no longer displayed when you use the
following:
• A MetaBot with run DLL migration function that takes more

than one parameter type as Array or any type other than
String

• A TaskBot with run logic calling a child бот that takes more
than one input parameter of type Array, which is mapped to a
List variable in the parent бот run logic migration function

8815 00704547 The Pause action of the TaskBot пакет now works properly
when you use it as the last task in the бот. Previously, the бот
did not wait for the task to complete if the Pause action was
used as last task in the бот.
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8815 00675344 A TaskBot now performs better when you use the Эмулятор
терминала Send text and Send key actions to execute a
бот. Previously, the TaskBot took a long time to complete the
execution.

8815 00699650,00716648When you use Распознавание изображений actions to execute
a бот and if the бот fails during execution, the captured
source and target images are stored in C:\ProgramData
\AutomationAnywhere\BotRunner\Logs\IR with a
maximum of 10 source and target image pairs. Now, when
the maximum limit is reached, the oldest image pairs are
overwritten with new images. Previously, the image logs were
not overwritten.

8815 00716817 A бот now executes successfully when you use the PDF Extract
text action to extract structured text from PDF files. Previously,
бот execution failed to extract structured text if it contained Thai
characters.

8815 00717204 You can now use a credential from the Credential Vault in the
URI field of the Веб-служба REST actions.

8815 00682726,
00678580,
00695359,
00684985

You can now use the Universal Recorder to automate in Oracle
Fusion Middleware applications. Previously, an issue with the Java
API caused the Recorder to select the entire window instead of
the specific object.

8815 00693770 Fixed an issue where numbers extracted from an SQL database
to a data table variable were automatically converted to scientific
notation.

8815 00669959 You can now select the same start date and end date when you
schedule боты with the Run repeatedly option (Activity >
Scheduled > Schedule bot) in the Control Room.

8815 00702841,
00700915

Disconnected devices are now displayed in the Control Room
(Devices > My Devices) when you filter the devices list by
Status as Disconnected.

8815 00707318,
00711529

Work items in an active queue are now processed and you no
longer have to delete the active queue and create another queue
after you upgrade from a previous release to this release.

8815 00705046 Боты that include embedded dependent files instead of a zipped
folder are no longer queued intermittently for deployment on Bot
Runner devices.

8815 -- Disabled tenant IDs or removed tenants that are later reused
on the same deployment with a different tenant might produce
a licensing error. This conflict is now removed and deboarded
tenants in later reuse no longer generate the error.
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8815 00685926 When you import an exported бот into the private workspace
and check in the imported бот, the бот is now checked in
successfully without any issues. Previously, the check-in failed
due to a metadata validation error.

8815 00682025 When a бот or a file is modified in the public workspace, the
cloned dependent file in the private workspace now reflects the
changes and the бот executes successfully. Previously, the cloned
dependent file did not reflect the changes and the бот execution
failed.

8815 00726018 The Google Drive Upload file action now uploads files to
subfolders.

8815 00715080,
00731152

You can now perform concurrent unattended бот deployment
on a multi-user device with multiple user sessions running
simultaneously.

8815 -- A non-admin Bot Agent user now remains connected to the
Control Room and is not disconnected frequently.

8815 00709737 Действия in the Google Sheets пакет now support worksheets
that contain empty cells.

8815 00710354 A hibernate exception error is no longer displayed when you log
in to the Control Room as an admin user.

8815 00732178 You can now check out боты from folders with similar names
but in different letter cases and edit the боты in your private
workspace in the Control Room.
For example, if there is a folder named Automation1 in the
public workspace and a folder named automation1 folder in
the private workspace, you can now check out боты from the
Automation1 folder in the public workspace.

8815 -- Боты are now deployed on a multi-user device in a non-admin
user session when another admin user session is also active on
the device if auto-login setting in the Control Room is set to lock
the session after the бот finishes executing from an existing
unlocked session.

8815 00719407 During a cluster installation of Enterprise A2019 on Red Hat
Enterprise Linux, the installer now uses the same user ID across
all cluster nodes.

8815 00703325 The log file permission for an Control Room installed on Linux
now maps to the crkernel user. Previously, it was mapped to the
root user.

8815 -- When you access the Control Room with the Login with
Windows option selected, you must now enter the FQDN to log
in successfully.
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Исправления

Сборка ID обращения
к облачному
сервису

Описание

8815 00732141,
00722919,00743006

When you preload a пакет, after the download is complete,
the completion status updates in the Activity > Historical
activity page and the pending record is no longer displayed in
the Activity > In progress page.

8815 00731376 When you migrate MetaBot logic, if there is case mismatch in the
variable name and the mapping variable, variables are no longer
created twice. As a result, a preprocessing error does not appear
when you execute the task.

8815 Now, the migration of run logic with CV variables is supported.

8815 Now, when using the Date system variable in the File folders
command, a migrated bot is no longer failing.

8815 When migrating боты (v11.x to A2019) with OC properties more
than 64KB, such properties will be truncated and the bot will be
migrated.

Ограничения

(ID обращения к облачному сервису: 00822176) When you create an RDP session on multi-user
devices and enter a custom port, RDP-based deployments will fail.
Рекомендации: Use the default port 3389 for RDP sessions.

When you create a бот with Open and Close browser actions in a loop and select the Window
option to close the selected tab, an error might occur when you execute the бот.
Обходное решение. Use the Close action of the Окно пакет instead of the Close action in the
Браузер пакет to close the window.

If you deploy боты using event triggers, and you install the Bot Agent on a device as a non-admin
user for self or a local admin user, the Bot Agent will not be updated automatically. The device is
will be shown as disconnected in the Control Room.
Обходное решение.
1. End the trigger listener Java process (javaw.exe) from the Task Manager.
2. Re-install the Bot Agent to reconnect the user device in the Control Room.

Configuring multiple IP addresses for Control Room nodes in a cluster is not supported during
installation in On-Premises deployments. You must manually configure the primary IP address in
the cluster.properties file.
Add primary IP address for cluster | Configure additional IP address for a new cluster node

Бот deployment on multi-user sessions is not supported for workload automation.

Using an Enterprise A2019.20 SDS On-Premises Control Room with an Enterprise A2019.19 SDS
Cloud Control Room is not supported.

When you run a бот containing a Capture action that uses the anchor object feature, your device
DPI settings must match the settings at which you configured the anchor object.
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Ограничения

The Control Room does not allow hyphens and underscores to be used interchangeably when
creating and calling global value names.

When you migrate an Enterprise 11 бот that uses Object Cloning command with Silverlight
technology and execute that бот in Enterprise A2019, the бот might fail with an error due to a play
reliability issue. The same play reliability is also seen in Enterprise 11 when you use Object Cloning
command with Silverlight plugins.

For actions that use file input, when you select a network path using Browse, бот execution fails
because the double backslash (\\) in the file location is replaced with a forward slash.
Обходное решение. Do not use the Browse option to select the file location. Instead, manually
enter the complete file path.

When a Bot Creator, attended Bot Runner or unattended Bot Runner user logs in to the Control
Room from their Bot Agent machine and if the package download option is enabled, the package
download takes priority, and бот deployment waits until the package download is complete. This
occurs only when the package is downloaded for the first time.

When a бот runs an automation in the Microsoft Internet Explorer browser, the Microsoft API
responsible for the browser delay might encounter an exception, causing the бот to fail and a
Chrome-related error message to appear in the Control Room.

(ID обращения к облачному сервису: 00712808) Automation Anywhere related files are
sometimes generated in C:\Windows\Temp. These files can be safely deleted.

For Enterprise 11 боты that contain an object that is captured using the Object Cloning command
using the Image or the Coordinate play mode, the Set Text is performed on that object and the
credential variable is used to set text for the object. The credential variable for these боты is not
migrated when the боты are migrated to Enterprise A2019.

If you use the Set text action in the Recorder > Capture action to enter data into a text box,
when you run the бот, the data appears over the old data in the text box and is not entered. The
old data is not cleared from the text box because the application requires a physical event to clear
the old data.
Обходное решение. To ensure that the data is entered into the text box, along with the Set
text action, add a value greater than 0 in the Time between keystrokes field.

When you use the Средство записи to capture an object, set the waiting time for detecting the
object to less than 30 seconds in the Keep trying for (seconds) field, and run the бот, the
Средство записи waits for a minimum of 30 seconds by default to detect the object.

When you use the Средство записи to capture objects on an application that is installed on a
virtual machine, finish the recording after the objects are captured, and relaunch the Средство
записи, the бот inserts the actions recorded earlier instead of launching the Средство записи.
Обходное решение. Refresh the Bot editor or run the бот to launch a new session to start
recording again.
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Automation Anywhere Robotic Interface (AARI)

Новые возможности

Get Storage file action
The new Get Storage file action in the AARI Web package enables you to download storage files
to a бот device.
AARI Web пакет

Upload files in initial forms or tasks
Add the Select File element to forms to enable users to select and upload files in the initial forms
or tasks in the web interface. Users can browse to upload a new file or replace an existing file. The
uploaded file is shown as a hyperlink and redirects users to a new tab when opened.

Настройка процессов

Hyperlinks support for initial forms or tasks
Use the new Hyperlink element to add links to forms and access them in initial forms and tasks.

Настройка процессов

Configure a scheduler user for each process (Service Cloud case ID: 00713786)
As an AARI administrator, you can now configure a scheduler user for each process to allocate the
Control Room resources (devices and unattended Bot Runner) on the web interface. By default, the
Global scheduler user is selected if a scheduler user is not configured for individual processes.
Configure scheduler user for AARI on the web

Update to properties panel for human task (Service Cloud case ID: 00718109)
As a Bot Creator, you can choose to not configure any actions in the human task by selecting the
Make the form read-only check box in the Properties panel. The human task does not require
any input and it is executed automatically to the next task.

Bookmark any page as landing page for AARI on the web
The web interface is now enhanced to a new multiple page system so that you can directly
bookmark any page (Requests, Tasks, or Recycle Bin) as your landing page. Also, the tabs
in the web interface have been removed so that the requests are opened one at a time and not
simultaneously. To perform multiple tasks, you can open the requests pages in different browser
tabs.

Navigation enhancement in AARI on the web
The web interface is now enhanced with a side navigation pane so that you can easily navigate to
various pages (Processes, Requests, Recycle Bin, and Tasks).

New processes page (Service Cloud case ID: 00694786)
As an AARI user, navigate to your assigned processes and create new requests by using the new
Processes page in the web interface. Use the navigation bar to quickly access the page.

© 2023 Automation Anywhere. All rights reserved.     442



    Automation Anywhere - Learn

Новые возможности

Enhancements to the Button element
• Use the Disallow button click when this form is first loaded option to disable the Button

element in a form when it is displayed for the first time during бот runtime.
• Use the Subtle option in the Button type drop-down menu if you want the button element to

appear as a link during бот runtime.

Использование элемента «Кнопка»

Усовершенствование логотипа формы
You can now use the Logos in footer field option to select up to two separate logos that are
displayed in the footer of the form during бот runtime.
Create a form

Изменения

Enhancement to the delete process
An AARI administrator or a user with the Delete from Public permission can now delete a process
in the public workspace. When the process is deleted from the public workspace, it is removed from
the process management page in the web interface. Additionally, if the process is already assigned
to any AARI user or team, access is removed after the process is deleted.
Delete an AARI process

Variable selector window update
The variable selector is now organized by Variable Source, Variable Type, and Variable
sections. The variable source contains a request or task. The variable type is now an interface
option for you to select an input, output, or meta types. The variable option specifies the variable
names and type.

Request variable source
The variable selector now enables users to select a Request variable source with an Input
(previously InitialData) and Meta variable types.

Создание процесса AARI | AARI variable types

Insert variables to existing text
You can use the variable selector in the process editor to insert or add variables without replacing
the existing texts.

Создание процесса AARI

Filter update
In the web interface, when you filter or search for keywords, the filter user interface now updates
and reflect the filter criteria accordingly. For example, if you search for the ending status of
requests, the filter shows Status: Pending.
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Исправления

ID обращения к облачному сервису Описание

00702607 If you have a Message box action within a trigger
loop, you can now use the Run from here option to
run the бот without any error messages.

00725237 Error messages are no longer displayed when the
Dropdown element in the form is populated with
dynamic values during бот runtime.

00733978 Forms with read-only elements can now be submitted
successfully without any issues when the value of the
form field exceeds 100.

- If you select any of the Advance behavior options
in the Dropdown element, error messages are no
longer displayed during бот runtime.

-- A Bot Task can now pass data to the next task
(Human Task or Bot Task) if it contains Japanese
characters in its output variable name. Previously,
English characters had to be used for the variable
name in the Bot Task.

-- In a cloud environment, the AARI web interface now
displays the correct screen for the selected locale.
Previously, the screen was not displayed correctly for
the selected locale.

Ограничения

In the process editor, the If/Else condition of string type does not allow the source and target
values to be empty. As a result, you cannot validate if a string variable is empty.
Обходное решение. Create an empty string output variable for the бот. Use this variable as the
target value to compare with a form or бот source variable so that the validation in the If/Else
condition does not fail.

When you enter data in a form of your process that contains a hyperlink, the data is ignored when
you try to submit the form. The hyperlink instead displays the following behaviors:
• When the hyperlink URL is configured at a designed time (the process of designing the interface

or setting properties), the URL remains unchanged by the process.
• When the hyperlink URL is not configured at a designed time, then the URL is set to the Control

Room domain.
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Discovery Bot

Новые возможности

Search for a business process from the Processes page
You can now use the search field to help you locate a specific process by name. The field is not
case-sensitive. The search field is available from the Processes page.
Create a Discovery Bot process

View all captured images from the screenshot modal window
You can now navigate across all captured screenshots when you click an image in full size from the
modal window. Щелкните разбивку на страницы, расположенную под изображением, чтобы
выбрать номер шага, или используйте стрелки вправо или влево для быстрого отображения
всех созданных изображений.

Запись бизнес-процесса Discovery Bot

Process Discovery package is included in default packages
The Process Discovery package is now included in the default packages. При подключении к
устройству можно предварительно загрузить пакет по умолчанию. Preloading the package
helps to speed the start time of the recorder the first time you begin recording a process

Необходимые условия для Discovery Bot

Recorder enhancements
You can now perform actions such as double-click, drag-drop, click and hold, and text select
when recording a business process. Действия, выполняемые с помощью нажатий клавиш,
отображаются в поле Данные. Double-click is captured by the recorder and displayed in the
screenshot from the Recordings page.

Прим.:  The Discovery Bot recorder does not capture the drag-drop and click and hold actions
from the Recordings page. To include these actions performed during the recording, you can
document the individual steps in the Step description text field for the analyst.

Запись бизнес-процесса Discovery Bot

Support for IPv6 addresses
IPv6 addresses are now supported for Discovery Bot.

Linux support
Discovery Bot is now supported on Red Hat Enterprise Linux and Linux CentOS platforms.
Installing Control Room on Linux

Support for high availability
Discovery Bot now supports high availability deployment.
High availability deployment
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Изменения

Changing default repository path for custom installation
For custom installation, you can now change the default repository path location to a new location
on your server after installation.

Необходимые условия для Discovery Bot

Исправления

ID обращения к облачному сервису Описание

-- You can now export a PDD for an opportunity
with 2000 steps by using the Download PDD
option from the Opportunities page.

Ограничения

When Tab is used to move across fields to a password-type field, the entered data is displayed as
clear text, for example, when you move from the Username to Password field. Review the text in
the Data field for confidential information before you submit the process.

Some actions might not be supported during a recording session, for example, when you click
through the Network tab in Inspect mode using Chrome. For such unsupported actions, pause the
recorder, complete the action, and then resume the recording.

When you record a process with 1000+ steps, the Recordings page takes some time to load.
Обходное решение. Depending on your environment, you can perform one of the following
actions:
• Split the recording into multiple recording sessions. For example, you can divide 1000 steps into

10 separate recordings.
• Wait for all the steps to load on the page before submitting the process for review.

IQ Bot

Новые возможности

Enhancement to the IQ Bot Classifier пакет
The Train Classifier action now provides an option to retrain the documents using an existing
model file.
Using Train Classifier action

Изменения

IQ Bot Pre-processor actions renamed
The names of all the available actions in the IQ Bot Pre-processor пакет are now changed. For
example, the Get barcodes action is now renamed as GetBarCodes.
IQ Bot Pre-processor пакет
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Изменения

Download all processed documents without any timeout (Service Cloud case ID: 00587817)
You can now download all your processed files from the Amazon S3 server to your local machine
without causing any timeout, irrespective of the number of files. Even when you choose the Delete
files from the server after downloading option and if your download fails, a compressed .zip
file containing the failed documents is available for downloading again.
Download all documents action

Enhancements to IQ Bot APIs (Service Cloud case ID: 00688683, 00688678, 00688675)
• File upload API now returns the file ID of the uploaded file.
• File status API now accepts a file ID and returns its status as a status code.
• File download API now returns the extracted data in JSON format for a successfully

uploaded file.

APIs to upload files, check file status, and downloading CSV file (A-People login required)

IQ Bot license renamed
The license required to run IQ Bot is now renamed to IQBot Platform from the previous
Cognitive Platform.
Licenses overview

Исправления

ID обращения к облачному сервису Описание

00708806 You can now save documents of up to 20 MB
after validating, without any issues.

00662968 Fixed an issue that caused the gateway service
to become unresponsive.

00644948 When you now upload a document in production,
deadlocks no longer occur in the system and
documents are correctly sent to the Валидатор.

00707965 When you now migrate from IQ Bot Enterprise
11 to A2019 using the Migration Assistant tool,
all database tables are correctly migrated,
without any errors.

00715124 IQ Bot now deletes temporary files downloaded
from Amazon S3 server in the C:\windows
\temp\ folder when they are no longer
required. As a result, storage is no longer
consumed by these temporary files.

-- Logs are now available for the IQ Bot node
servers in the C:\Users\Public\Documents
\Automation Anywhere IQBot Platform
\Logs\ folder.

© 2023 Automation Anywhere. All rights reserved.     447

https://apeople.automationanywhere.com/s/article/IQBOT-API-s-to-UPLOAD-Check-FILE-STATUS-DOWNLOADING-FILE


    Automation Anywhere - Learn

Исправления

ID обращения к облачному сервису Описание

-- IQ Bot now displays the correct error message
when you refresh the extraction results page for
a learning instance when its associated бот is
moved to production.

-- When creating a table on the Designer page,
if you click See Extraction results without
completing the table creation, the correct error
message is now displayed.
Previously, the following incorrect message was
displayed: Preview will be opened in a
 new tab.

-- When a бот is deleted and you click the
Test bot option on the Боты listing page,
the following correct error message is now
displayed: Bot not found.

-- Python logic is now correctly applied on all
the tables. Previously, IQ Bot failed to execute
Python logic for tables other than the default
one.

-- You can view more granular logs for
troubleshooting RabbitMQ v3.8.18 issues. These
logs are now stored in the C:\Users\Public
\Documents\Automation Anywhere IQBot
 Platform\Logs\RabbitMQ folder, depending
on the log level, log size, and the rotation limit.
If any error occurs in the RabbitMQ v3.8.18
connection, those crash logs are stored in C:
\Users\Public\Documents\Automation
 Anywhere IQBot Platform\Logs
\RabbitMQ\log folder.

-- When you now create a user role with 2-byte
non-English characters, services no longer fail to
execute.

-- If there is an existing database, IQ Bot installer
now does not check for the db_creator role
for that user.

-- A user with AAE_IQ Bot Validator role
and AAE_Basic role can now successfully
launch and validate documents in the IQ Bot
Валидатор.

Ограничения

IPv6 addresses are not supported for IQ Bot, so ensure that you use IPv4 addresses only.

If you try to apply Python logic to a linked column between two tables, an error message is
displayed for the linked column in the second table and the applied logic fails.
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Ограничения

If you add a blocked library to a custom Python logic and click Test Run for any field, an error
message is displayed on the designer page.
Обходное решение. Remove the blocked library from the Python logic.

If you use the Overwrite option to import a learning instance, all the available боты and groups
are imported.

When you use the Process documents action from the IQ Bot Extraction пакет to run a бот
through workload management, the Current Action tab displays Downloading additional
resources along with your command instead of IQ Bot extraction in the In progress
activity page.

Average processing time increases when you use the IQ Bot Extraction пакет on a document with
more than 30 pages.

Running existing боты that use the IQ Bot Pre-processor пакет might fail after you upgrade to this
release.
Обходное решение. Because the names of the available actions in the IQ Bot Pre-processor
пакет have changed, delete the existing actions in the боты and update them with the new names
before running the бот.

(ID обращения к облачному сервису: 00601790) You cannot register IQ Bot when the Control
Room is installed on a Linux machine.

When you run a бот that has the IQ Bot Extraction пакет, the activity information under In
progress > Current Action does not display the details correctly.

If you use the File Download API option, the json response you receive does not have a valid
format.
Обходное решение. This issue occurs because the : (colon) is replaced by = (equal sign) in the
json key value. After you receive the json response, use these options:
• Replace = with :
• Add " (double quotation marks) in each text

When you try to sort the PagesUpload column in the Learning instance > Document Group
tab, an error message is displayed.

On the Designer, if you resize the system identified region (SIR) of an auto-mapped field, the values
from the resized selection are not captured in the corresponding value field.
Workaround:To update the content of an auto-mapped field:
1. Select the entire SIR region.
2. Draw a bigger bounding box around the region.
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Bot Insight

Новые возможности

AAE_Admin role access to operations API from Power BI connector
The Power BI connector now provides the AAE_Admin user role access to the botrundata
operational API. With this role, you can connect to the botrundata API and extract operational
metrics to be analyzed and visualized within Power BI.

Enhancements to the publish (production) dashboard
Users with the AAE_Bot Insight Admin and AAE_Bot Insight Expert role can now edit the
published dashboard. You can use the save as option to save the production dashboard as a custom
production dashboard and add widgets to your custom dashboard. You can also delete a default
production dashboard and a custom production dashboard.
Save a published dashboard | Delete a published dashboard

Важное замечание:  The supported packages information is moved to this topic: View пакет versions
available in the Control Room.

Enterprise A2019.19 Release Notes
Дата выпуска: 11 February 2021

Review the new features, changed features, fixed features, security fixes, deprecated features, and known
limitations in the Enterprise A2019.19 release. Enterprise A2019.19 Сборка 8147 is available for On-
Premises and Сборка 8145 is available for Cloud. IQ Bot is on Build 8098.

Важное замечание:  We have updated the Enterprise A2019.19 builds to include fixes for the following
issues:
• System variables that are displaying blank in the action field (Service Cloud case ID 00737695,

00737698)
• Editing the table size when creating a new table variable in On-Premises (Service Cloud case ID

00725978, 00727695, 00736105)
• Issues editing a бот in the Bot editor and opening the пакеты listing page that includes special

characters (Service Cloud case ID 00733529, 00739634)
• Assigning a бот from the private workspace to a file variable (Service Cloud case ID 00727695)
• Действия in the Распознавание изображений пакет not allowing the use of files with .PNG extension

and files with uppercase letters in the extension (Service Cloud case ID 00734972, 00734266)
• Variable names in uppercase changing to lowercase, hyphen changing to underscore, and variable not

being displayed if it contained an uppercase character (Service Cloud case ID 00734784, 00734842,
00734999)

• Боты not getting deployed on a multi-user device when the user session is signed out and no active
session existed (Service Cloud case ID 00727228, 00722888, 00732830, 00732835, 00733877,
00733362, 00726489, 00733070, 732959, 733160, 733269,733321, 733391, 733435, 733438, 733451,
733680, 733765, 733770, 733790, 733940, 00734067)

• Child боты encountering an error if they contained the Find window in window action of the
Распознавание изображений пакет (Service Cloud case ID 00727031, 00730358, 00733607,
00733544, 0073464)
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• Use of variables with camel case names in the Таблица данных, Список, and Цикл пакеты (Service
Cloud case ID 00733263,00733459, 00733007, 00733988, 00734168, 00733141, 00733074, 00733087,
00733001,00734019)

For more information, see the Fixed features sections for Enterprise A2019 and AARI.

• Особенности миграции
• Enterprise A2019
• AARI
• Discovery Bot
• IQ Bot
• Bot Insight

Особенности миграции

Enterprise 11 and Enterprise 10 features

Review messages in Migration Assistant
The Migration Assistant displays review messages for migrated боты. Open the migration assistant
for a бот to review messages for that бот.

Просмотр изменений в перенесенных боты с помощью Бот Assistant

Migrate MetaBots with screens
Migrate MetaBots that contain screens as assets. You can migrate screens based on UI Automation
technology and captured using the Object play mode.

Как выполняется миграция MetaBots

Review messages in Bot Scanner report
The Bot Scanner report shows review messages about the behavior change in commands that are
used in боты that can be migrated to Enterprise A2019.

Анализ отчета Bot Scanner для миграции

Stop, or pause and resume migration
You can stop, or pause and then resume the migration process from the бот launcher and the
Activity > In progress page.

Остановка миграции бот | Приостановка и возобновление миграции бот

Migrate боты that use capture scrollable text action in Интеграция приложений
command
Enterprise 11 and Enterprise 10 Интеграция приложений commands that capture text from an
application window with a vertical scroll bar are migrated to the App integration > Capture
scrollable text action in Enterprise A2019.

Сопоставление пакетов для миграции
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Только для Enterprise 11

Map output of Интеграция с PDF command to multiple variables
The output of an Enterprise 11 бот that uses the Интеграция с PDF command is mapped with
multiple variables in the equivalent actions of the PDF пакет after the бот is migrated to Enterprise
A2019.

Migrate боты that use the following attributes:
• Боты that send Japanese text in the VT100 terminal using the Send Text command
• Боты that use the Get Single Node or the Get Multiple Nodes command to extract nodes

that contain namespaces from an XML file
• Боты that contain the Connect command of the Эмулятор терминала command and the value

in the Wait Time Out field that is less than hundred milliseconds

Migrate bots that use the following options in the Active Directory command:
• The Modify Object command with the Rename, Delete, Move, and Set Property actions for the

Computer and Organizational Unit object type.
• The Modify Group command with the Add users to a group and Remove users from a

group actions.

Сопоставление пакетов для миграции

Только для Enterprise 10

Migrate latest version of Enterprise 10 боты enabled with version control
You can now migrate the latest version of боты from your Enterprise 10 Control Room configured
with SVN version control to Enterprise A2019. Use the Copy 10.x data option to copy the latest
version of the Enterprise 10 боты to Enterprise A2019 and then use the Bot Migration Wizard to
migrate the боты to Enterprise A2019.

Копирование данных Enterprise 10 | Процедура копирования данных Enterprise 10 в Automation
360

Enterprise A2019

Важное замечание:  This release includes a required update to your . Ensure that you complete the
update to continue with your automation activities when upgrading from a previous release to this release.

Автоматическое обновление Bot Agent | Обновление Bot Agent вручную

To verify which  version is compatible with this release, see Compatibility with release builds.
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Новые функции

Auto-login settings
Use the auto-login configuration in the Control Room to reduce бот startup time by reusing
an existing user session. Configure auto-login in the Administrator settings for all devices or
customize it from the Devices page for each device.
• Configure the auto-login settings for a user session to create a new session or reuse an existing

session
• Keep user sessions unlocked
• Log off from a user session after the бот completes execution

Configure auto-login settings | Устройства

New CPU utilization and device memory settings
Configure the CPU utilization and device memory threshold value in the Control Room settings to
determine whether to deploy боты on devices or not.
Configure threshold settings for user devices

Install Bot Agent on devices without administrator privileges
You can now choose to install the Bot Agent on user devices with either local user privileges
(without administrator privileges) at the local user level or administrator privileges at the system
level.

Установка Bot Agent и регистрация устройств | Create device pools | Пользователи
When you install the Bot Agent at the user level, the device will not be available as a default device
for another user or for device pool selection during бот deployment. For more information, see Bot
Agent known limitations.

New diagnostic utility for Bot Agent
Use the Bot Agent diagnostic utility to perform diagnostic checks on Bot Runner devices and to
resolve Bot Agent connectivity issues.

Выполнение диагностических проверок Bot Agent

New features in Таблица данных пакет (Service Cloud case ID: 00656843, 00707635)
• Use the Change column type action in the Таблица данных пакет to perform operations

on the column of a data table. Use this action to change the column data type to Boolean,
Datetime, Number, or String.

• Sort the data in the data table in Number, Datetime, Boolean, or String format.

Таблица данных пакет

Новое action в пакет Интеграция приложений
Use the Capture scrollable text action to extract text from the selected window or any control
within the selected window and save it to a variable. If you click any control within the window,
then text from that specific control is extracted. If you click outside the window, then all the text
from that window is extracted.

Интеграция приложений пакет
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Новые функции

New encoding combo box option in Эмулятор терминала for VT Series
To send and receive Japanese text, you can now use the Encoding and CodePage combo boxes
when you connect to the Terminal Emulator for the VT series terminal type.
Using Connect action for Эмулятор терминала

New actions in Active Directory пакет
Use the following actions in the Active Directory to automate a task:
• Move a computer

Using the Move computer action
• Move an organizational unit

Using the Move organizational unit action
• Add users to a group

Using the Add users to group action
• Remove users from a group

Using the Remove users from group action

New system variable for new line character (Service Cloud case ID: 00669232, 00672775,
00673578)
Use the $String:Newline$ system variable to add a new line character. This variable adds a new line
character in various applications regardless of the operating system of the device.

Zero-size form for Enterprise A2019 (Service Cloud case ID: 00677611)
The Run action uses the zero-size form with name AAZeroSizeForm that can be used by DLLs to
identify zero-size forms created by Enterprise A2019.

Enhancement to define parent path in Active Directory
When you establish a connection with an LDAP server, you can now select the LDAP path by
connecting to the server.
Using Connect action for Active Directory

Obtain information about Run-As user after бот deployment
Use the AATaskExecutor system variable to return the username, first name, last name, and email
of the user that ran the бот. If the бот is deployed on an attended Bot Runner, this variable returns
information about the logged-in user. If the бот is deployed by a trigger, this variable returns
information about the user associated with that Bot Runner license.
System settings and parameters

Enhancements to the Средство записи
• Universal Recorder now supports object capture in Mozilla Firefox.

You must install the A2019 extension from Mozilla Firefox browser add-ons.
• Capture table, grid view, and main window objects from SAP applications.

Universal Recorder supported applications and browsers | Actions performed on objects captured with
Universal Recorder
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Новые функции

Multi-user device supported on Citrix Windows 10 Enterprise (Service Cloud case ID:
00526001)
Multi-user device sessions are now supported on Windows 10 Enterprise on Citrix, enabling multiple
users to access the same device at the same time.

Event triggers on unattended Bot Runner (Service Cloud case ID: 00681548)
Ensure that you select the Reuse an existing session option for auto-login settings in the
Control Room to use event triggers on unattended Bot Runner when a device is locked or is in a
disconnected state (such as RDP).
Configure auto-login settings

Auto Login support on Citrix VDI (Service Cloud case ID: 00680200)
Auto Login is now supported on Citrix VDI, which enables бот deployment in unattended mode.
Configure auto-login settings.

Restore боты from Git repository
If your database is deleted or corrupted, the admin user can restore all your боты and the
associated dependent files from the Git repository to your new empty database.
Restore боты from Git repository

Bot Deploy API checks for available devices in the order of listed pool IDs
If you enter multiple pool IDs in the request body, the API checks the pools for available devices in
the order that you listed the pool IDs. Если на момент развертывания нет доступных устройств,
автоматизация ставится в очередь.
Bot deploy API

Измененные функции

Enhanced security for multi-user Bot Agent devices (Service Cloud case ID: 00695858)
The Bot Agent configured on multi-user devices for RDP-based deployments now uses the updated
version of wfreerdp.exe for enhanced security.

Deployment API enhancement (Service Cloud case ID: 00655548)
When you invoke a regular deployment API, if a RunAsUser is being used to deploy a бот, the
deployment API will not deploy other боты until the RunAsUser is free to run the other боты.

Status change initiates workload automation deployment
When you change the status of a Work Item from Failed to New in the Control Room (Queues),
the deployment of a workload automation in queue is initiated.

Install Google Chrome Enterprise extension offline with Bot Agent (Service Cloud case ID:
00623511, 00689623, 00715413)
You can now install the extension for Google Chrome Enterprise offline from the Bot Agent setup
and MSI files.
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Измененные функции

ANSI as default encoding in Таблица данных пакет
For text write operations, Таблица данных пакет > Write to file action supports ANSI as default
encoding type.
Боты created in the previous version of Enterprise A2019 with UTF-8 is not impacted by this
change.

Усовершенствование пакет PDF
In the PDF пакет, when you enter an incorrect page range in the Page range field and execute
the бот, an error message is now displayed, requesting you to provide the correct page range. The
message is displayed for the following actions:
• Объединить документ
• Разделить документ
• Извлечь текст
• Извлечь изображение

Боты wait for Google Chrome web page to load
When automating a task in the Google Chrome browser, боты now wait up to 30 seconds for the
web page to load, and then run the subsequent Recorder > Capture action. When the page
loads, боты search for the object for the duration specified in the Wait for control field. Waiting
for the web page to fully render increases the bot's ability to identify the target object in the web
page.

Enhancement to desktop operations
When you create a бот and select an option for desktop operations, the data selected from the
drop-down list now persists even when you navigate to other fields.

Flow view updates in the Bot editor (Service Cloud case ID: 00701626)
• The Flow view is disabled when you create or edit a бот and the бот exceeds 500 lines of code.

Используйте параметр Показать представление списка для перехода к представлению
списка.

• In the Bot editor Flow view, a warning message is displayed when the бот exceeds 400 lines of
code or if the бот has more than 100 variables.

The following table lists the fixed features and the builds in which they were fixed (Сборка 8147 is the
latest build, and builds 8145, 8134, 8122, and 8098 are the previous builds). These fixes are cumulatively
available in the latest build.

Исправленные функции

Build number ID обращения к
облачному сервису

Описание

8147 00737695 When you insert a system variable into an
action field, the variable now appears in that
field.

8147 00725978, 00727695 When you create a table variable in On-
Premises, the table expands to the full size of
the window. Previously the table only showed
three rows at a time.
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Исправленные функции

Build number ID обращения к
облачному сервису

Описание

8147 00733529,00739634 You no longer encounter any issues when
you edit a бот in the Bot editor and open the
пакеты listing page. Previously, if an installed
пакет had an object name with a space (' ')
character in it, the пакет listing page displayed
an error.

8145 00727695 You can now assign a бот from your private
workspace to a file variable.

8145 -- When you create a variable in an action, the
variable automatically appears in the field for
which you created the variable.

8145 -- You can now use .png files in actions in the
Распознавание изображений пакет.

8145 00734972, 00734266 You can now select a Control Room file with
uppercase letters in the file extension in the
Image Recognition > Find image in
window action.

8145 00734784 Variables names are now displayed correctly
in the Bot editor List view; uppercase letters
in the variable name are no longer changed to
lowercase letters and hyphens are not changed
to underscores.

8145 00734842, 00734999 Действия now display Boolean, date time, or
list type variables if the variable name contains
uppercase letters.

8145 00727228, 00722888,
00732830, 00732835,
00733877, 00733362,
00726489, 00733070,
732959, 733160,
733269, 733321,
733391, 733435,
733438, 733451,
733680, 733765,
733770, 733790,
733940, 734067

You can now deploy боты on a multi-user
device when the user session is signed out
and no active session (signed in, locked, or
disconnected) exists either for that user or
any other user. The following error message is
no longer displayed on the View historical
activity (Activity > Historical) page:
Unable to perform auto-login for
user <username>.

8145 -- The Cloud migration utility no longer keeps
running in the background if you close the
utility when the Enterprise 11 data is being
uploaded.

8134 00727031, 00730358,
00733607, 00733544,
00734642

You can now successfully execute боты when
you use Распознавание изображений with
the Find window in window action in a child
бот. Previously, бот execution failed when you
used Распознавание изображений with this
action in the subtask.
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Исправленные функции

Build number ID обращения к
облачному сервису

Описание

8134 00733263,00733459,
00733007, 00733988,
00734168, 00733141,
00733074, 00733087,
00733001,00734019

The Таблица данных, Список, and Цикл
пакеты now support variables with camel case
names.

8122 00713867 Variables are now listed in alphabetical order
in the Variables palette and in the Insert a
value window that appears when you press
the F2 key.

8122 -- The Control Room now does not take time to
launch, and the following error message is no
longer displayed: An Unexpected Problem
Occurred.

8098 00689022, 00697417,
00697420, 00697079

A Bot Agent device no longer disconnects
from the Control Room that is configured on
Microsoft Azure. The following error message
is no longer displayed: disconnecting due
to outstanding pong.

8122 00719167, 00721731 Tasks such as scheduling боты and connecting
to user devices are not delayed in an Control
Room hosted on Cloud.

8098 00626595, 00680433 The actions in the Распознавание
изображений пакет no longer return an
incorrect error message about the target image
data type.

8098 00698201 Fixed an issue where боты were stuck in the
preprocessing mode when the бот was used
as a child бот in several running боты or was
deployed back to back using the Deploy API.
Now боты are deployed from the cache and
fewer calls are made to the database, thus
avoiding a database deadlock.

8098 -- The Bot Scanner now displays the correct
message for the MetaBot logic that contains
credential variables that cannot be migrated to
Enterprise A2019.

8098 00687223 An Enterprise 11 бот that passes a blank value
as an input to the string, list, one-dimensional
array, and two-dimensional array of string type
variable used in a DLL no longer encounters an
error when you run that бот after migrating to
Enterprise A2019.

8098 00677231 A бот is no longer unresponsive if it contains
an action to close the Google Chrome browser
followed by an action to open the Google
Chrome browser.
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Исправленные функции

Build number ID обращения к
облачному сервису

Описание

8098 00687207 When an Enterprise 11 бот contains objects
captured using the Object Cloning command
and that object has a property that contains
an expression within the $ character, the
Enterprise 11 бот no longer encounters an
error after migration.

8098 00689286 The Bot Scanner no longer encounters an
error when you scan an Enterprise 11 бот
that contains the Если command with the
Windows control condition selected and is
automating a task on a Microsoft Excel file.

8098 00706438 An error is no longer encountered when you
are installing Enterprise A2019 and:
• You are migrating from Enterprise 11 to

Enterprise A2019
• Active Directory is configured on the

Enterprise 11 Control Room
• The restored Enterprise 11 database

contains the AAE_Meta Bot Designer role

8098 00708522 An error is no longer encountered when you
clone a dependent file of an Enterprise 11 бот
after it is migrated to Enterprise A2019. The
error is encountered only when the migrated
бот contains a null description.

8098 00626664 You can now migrate боты that automate tasks
in BMC applications. The migrated боты use
the Legacy automation > Manage web
controls action to automate interactions with
objects.

8098 -- You can now select the regular expression
Case insensitive option in actions that
contain a window title field and successfully
perform a recapture in the application window.

8098 00688134 In the База данных пакет, Korean characters
are now displayed properly when you use the
Insert/Update/Delete action in an Excel
file. Previously, the Korean characters were not
displayed properly when the action was used.

8098 00675749 In the Эл. почта пакет, you can now forward
an email using groupId or Alias. Previously, the
mails were not sent by the SMTP server if the
email address contained groupId or Alias in the
To address field.
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Исправленные функции

Build number ID обращения к
облачному сервису

Описание

8098 -- You can now use a double backslash (\\) in the
Send text action of the Эмулятор терминала
and execute боты. Previously, when a double
backslash (\\) was used in this action and the
бот was executed, the terminal displayed a
single slash (\).

8098 00688692 When you connect to the EWS server to read
mails using Цикл, the retrieved email now
displays the content correctly per the selected
mode (HTML or plain text formats). Previously,
when connecting to the EWS server to read
an email in HTML format, the email body
displayed a blank output.

8098 00659456 In the Цикл пакет, when you select For
each file in folder as the Iterator option,
the Note below the Assign file name and
extension to this variable field now displays
the key name in English. Previously, the key
name in the Note was translated to the
languages you selected.

8098 -- A бот no longer runs intermittently when the
focus changes from one window to another
window and does not display the Type_015
Google Chrome plug-in error.

8098 00683528 In the База данных пакет, single entries
are now inserted in the database when you
execute a store procedure to add rows in the
table and the option Export data to CSV is
selected. Previously, duplicate entries were
added in the database.

8098 00693664 Fixed an issue where Japanese characters did
not display correctly when input into a field
that contained a variable.

8098 00677167 The ячейка Participants tab now shows
only the assigned participants for that specific
ячейка. Previously, the tab displayed the
participants of the previously viewed ячейка,
requiring the user to refresh the browser to
see the correct participants.

8098 -- The Control Room services can now be run
using the non-administrator service account
users. The Bad Gateway error message is no
longer displayed.

8098 00691232 Fixed an issue that did not allow users to
update the value of a file type input variable
after saving the бот.
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Исправленные функции

Build number ID обращения к
облачному сервису

Описание

8098 -- The Save option is now correctly enabled
when users make any changes to the
metadata, unique entity, or SAML assertion
mode.

8098 -- The username is no longer saved in the login
window after the user logs out unless the user
has selected the Remember my username
option.

8098 00682021 When you check in a бот that has cloned боты
as dependencies, the dependent files are no
longer lost from the private workspace. Also,
after the check-in, if you create a new бот
using the same dependencies as in the earlier
бот, the new бот executes successfully.

8098 -- Work Items are now processed for workload
automation after you add more Work Items to
an existing queue.

8098 -- Work Items are now reprocessed for workload
automation after you change the status from
failed to new.

8098 00711410 You can now migrate workload automations in
an Control Room configured to use a manual
mode for Credential Vault.

8098 00667047, 00673289 Auto-login for a user session no longer fails for
боты deployed on virtual machines when the
VDI session is disconnected or is in a locked
state, and the following token error message is
no longer displayed: An attempt was made
to reference a token that does not
exist.

8098 00560593, 00585092 Universal Recorder is now aligned with the Bot
Agent, so the recorder can capture objects on
devices with any proxy server configuration.

8098 00675695 When you use the Расширенный Excel пакет,
the бот now opens an Excel file without any
issues. Previously, the боты failed to open an
Excel file in some scenarios due to internal
hardware components.

8098 00678567 CSV formulaic entries are no longer permitted
in data fields of web applications, such as
device names. These fields are limited to
accept alphabetic characters, numbers,
hyphen, and underscore entries only.

8098 00691551 Turkish characters are now supported in user
names.
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Известные ограничения

When you update the Bot Agent from user level to system level, the user is unable to capture
objects using recorder actions or from a window list in a Google Chrome browser.
Обходное решение. Remove the registry entry for the user. Ensure the registry
entry is in HKLM: Computer\HKEY_CURRENT_USER\SOFTWARE\Google\Chrome
\NativeMessagingHost\Automation*.

When you uninstall the Bot Agent, the Bot Agent service and registry entry are not removed.
Therefore, subsequent Bot Agent reinstallations fail.
Обходное решение.
1. Stop the Bot Agent service from the Task Manager.
2. Delete the Bot Agent registry key from Computer\HKEY_LOCAL_MACHINE\SYSTEM

\ControlSet001\Services\Automation Anywhere Bot Agent.
3. Reinstall the Bot Agent.

When you install a Bot Agent at the user level, the user device is not registered as admin.
Обходное решение. Before installing the Bot Agent, ensure that the user has write permission
to the user profile folders (for example, C:\Program Files).

When you deploy a бот using a custom пакет and if the пакет has an object name with a
semicolon (;) or percentage (%) character in it, the бот execution fails.
Обходное решение. Do not use special characters such as a semicolon (;) or percentage (%) in
the custom пакет name.

Limitation for multi-user deployments with auto-login
If the auto-login setting in the Control Room is set to lock the session when the бот finishes
executing from an existing unlocked session, deployments will fail when you deploy a бот on a
multi-user device with non-admin user session and another admin user session is also active on the
device.
Обходное решение. Restart the Bot Agent service from the Windows Start menu and log off
from the admin user session.

Bot Agent installation
Starting from this release, when you install the Bot Agent at the local user level, keep the following
in mind:
• You cannot install the Bot Agent at the user level if you log in to the device as the root

administrator.
• Auto-login is not supported for local users and unattended Bot Runner.
• The auto-update feature for the Bot Agent will be applicable from the subsequent release

because the option to install the Bot Agent at the local user level is introduced in this release.
• You cannot configure multi-user devices.
• Enterprise A2019 recorders for third-party applications:

• No separate setup is required for JRE 6 and 7.
• Citrix XenApp is not supported because administrator privileges are required to set up Citrix.
• You must upgrade to the Enterprise A2019.19 Средство записи package to use Discovery

Bot.
• You must have write permission to AISense Recorder logs.
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Известные ограничения

Боты encounter a Java heap space error when they use the Базовый Excel пакет to open an Excel
file that is 20 MB or larger.
Обходное решение. Increase the Java virtual machine heap space to 8 GB:
1. Navigate to C:\Program Files\Automation Anywhere\Bot Agent\config.
2. If it does not already exist, create a new text file named nodemanager.properties.
3. Open the file and copy the following text and paste it in the file:

bot.launcher.jvm.options=-Xmx8092m

4. Open Windows Services and restart the Bot Agent.

Боты wait a maximum of 30 seconds for an object to appear in the Google Chrome browser,
regardless of the value in the Wait for control field in the Recorder > Capture action.

Limitations in Cloud migration
• The backup of the Enterprise 11 data created by the Cloud migration utility is not deleted when

you close the Cloud migration utility after the Enterprise 11 data is uploaded to Cloud.
• Enterprise 11 боты that contain Japanese characters in their name encounter an error when you

run these боты after they are migrated to Cloud.
• The Cloud migration utility does not show a validation error when you run the utility and the

Automation Anywhere Control Room Reverse Proxy service is running if you have reinstalled
Enterprise 11 Control Room using the same database that you have used in the previous
Enterprise 11 instance.

(ID обращения к облачному сервису: 00737669) When you upgrade to this release, the Bot
Agent is also updated. As a result, all the event triggers associated with Bot Runner (attended or
unattended) users are stopped.
Обходное решение. Bot Runner (attended and unattended) users must re-login to the Control
Room to activate the associated event triggers.

Enterprise 11 боты that use identical names for variables that are differentiated by a hyphen or
an underscore (for example, L-Lower and L_Lower) encounter an error when you run them after
migrating to Enterprise A2019.
Обходное решение. Update the name of one of the variables to a different name before
migrating the бот.

String system variables do not function in Эл. почта action fields when the format is set to HTML.
Обходное решение. Use HTML tags that perform the same function as the string variables. For
example, instead of $String:Enter$ or $String:Newline$, you can use the HTML tag <br>.
Similarly, for the string variable $String:Tab$, you can enter &nbsp.

When you insert a variable into an action field that contains other content, the variable appears at
the end of the content, regardless of the cursor position.
Обходное решение. Highlight the variable name, and then cut and paste it to the correct
position in the action field.
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Известные ограничения

(ID обращения к облачному сервису: 00781974) In a Linux environment, some of the Control
Room log messages are stored in the /var/log/messages file instead of the /var/log/
automationanywhere directory. As a result, disk space increases, and the services might stop
when the disk space is full.
Обходное решение. Clear the messages file regularly to avoid a disk storage issue.

Automation Anywhere Robotic Interface (AARI)

Новые функции

New filter task in the process editor
In the process editor, the Filter Task enables users to filter variables such as human or бот task
output with a specific filter criterion.

Создание процесса AARI

New process task in the process editor
Use the new Process Task option in the process editor to call a subprocess within the main
process. This feature enables you to separate tasks into different processes instead of including
all the tasks in a single process. Multiple teams can now work at the same time on different tasks
within the main process and remain segregated, without any conflicts.

Создание процесса AARI

Hide a task or view a hidden task
With a Bot Creator license, you can now perform the following:
• Hide the display of human and бот tasks by selecting the Hide this task after completion

option in the process editor.
• View a hidden human or бот tasks by selecting the View hidden tasks option in the tasks view

page.

Создание процесса AARI

Edit title in process editor
Users can now edit the title in the process editor.

Rich-text editor updates (web interface)
In the web interface, you can use rich-text editor features such as bold text, italics, underline,
alignment, formatting, color, and size in tasks.

Table element updates (web interface)
In the web interface, the Table element now supports the use of date, number, drop-down, and
text values in tasks.
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Новые функции

Updates to elements in form builder
The form builder now includes the following new elements:
• Select Folder element: Add an upload folder option in the form.

Using the Select Folder element
• Hyperlink element: Assign a URL in the form.

Using the Hyperlink element

Enhancement to the Checkbox action trigger
If a form with a Checkbox element is used within a trigger loop пакет, you can now use the
Value selected and Value unselected trigger actions.
Trigger loop пакет

Измененные функции

Create and view requests (AARI manager)
An AARI manager can create and view requests from processes that are assigned to the team they
belong to or own. They can also create and view requests from processes that are assigned to
themselves but not to the team.

Same device cannot be assigned to Bot Creator and unattended Bot Runner for triggers
After you update to this Enterprise A2019 version from an earlier version, a default device that is
assigned to a Bot Creator or an attended Bot Runner cannot be assigned to an unattended Bot
Runner for deploying triggers.
Recommended action: Use separate devices or device credentials (auto-login) for a Bot Creator
and an attended Bot Runner as deployments can overlap or override across licenses.

Create a Request action URI
The process selector in the Create a Request action is replaced with a public repository uniform
resource identifier (URI).
AARI Web пакет

Исправленные функции

Build number ID обращения к
облачному сервису

Описание

8134 -- The table element now renders properly even
when the Row before scrolling parameter
value does not match the number of rows.
Previously, the table did not render properly
and displayed empty cells.

8122 -- When you check out a process, and add,
modify, or remove tasks in the process editor,
the dependencies are now correctly updated
when the process is checked in.
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Исправленные функции

Build number ID обращения к
облачному сервису

Описание

8098 00707684, 00707688,
00707192, 00706781,
00707900, 00709109

All event triggers are now retained when you
update to this version from an earlier version.

8098 -- In the process editor, undo and redo functions
are now available for both canvas and
properties panel interactions by default.
Previously, the undo and redo functions were
only available for canvas interactions.

8098 -- Previously during бот runtime, if you deleted
all the existing rows from a table before adding
a new row, the columns and rows of the table
were misaligned. You can now drag and resize
any column to reset the table alignment.

8098 -- All the trigger events within a form are now
retained and no longer fail when the form is
closed and reopened during бот runtime.

8098 -- In the process editor, if you replace the Go
to option with an End process, the End
process icon now displays the correct status
(Completed, Failed, Canceled). Previously, the
status was not displayed correctly and had
to be changed manually by using the End
process option.

8098 -- Теперь при удалении запрос со вкладки
Запрос отправляется в корзину, а
связанная с ним задача со вкладки Задача
удаляется.

8098 -- When you filter your tasks in the Task tab,
the results shown in the tab now retain the
information when you navigate between
different tabs.

Deprecated features

Support removed for device pool configuration
An AARI administrator can no longer use the device pool configuration to deploy боты in a process.
After upgrading to Enterprise A2019.19 from an earlier version, verify that the scheduler user
configuration is set up in order to successfully execute your боты in the process.
Configure scheduler user for AARI on the web
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Известные ограничения

When you create a request from a process (public or private) and enter all the required information
in the initial form, the initial form cannot be submitted because the Submit option does not work.
This issue occurs for all initial forms with at least one mandatory field.
Обходное решение. Make all fields optional.

When you submit an initial form or task in a request view that contains a check box with at least
two options and at least one option is selected, the check box value is not changed and defaults to
a false Boolean value.

If the Set action is used immediately after a Get action, the value assigned to a variable using the
Get action is not retrieved in the specified form element of the Set action during бот runtime.

An AARI manager can create a request from a process that is assigned to them but not to their
team. They can create and complete the request if the process contains only бот tasks. If the
process contains a human task, the manager cannot assign the human task to themselves.
Обходное решение. Assign the process to both the manager and their team.

In the process editor, the Go To option shows only the Human Task and Bot Task, it does not
show the Filter Task or the Process Task.

(ID обращения к облачному сервису: 00736309, 00765069, 00784362) If you use a file trigger for
a document that is in .csv, .xlsx, or .xls format, the corresponding бот is not triggered when
that document is modified.

Discovery Bot

Новые функции

View the duration of each recorded step
A recorded step is now displayed in minutes and seconds for the business user and analyst. Use
this information to understand which steps are a bottleneck in the current process and will provide
most benefit from automation. The step duration is displayed from the Recordings page (below
the screenshot image), and from the View process and View opportunities page from the
Preview pane window.

Запись бизнес-процесса Discovery Bot

Измененные функции

Enhancement to the screenshot
The screenshot image of the recorded step is now increased to full size for a more clear, detailed
view of the recorded step.
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Исправленные функции

ID обращения к облачному сервису Описание

-- You can now click the Screen icon to display
an image that you have hidden and saved.
Previously, you had to click Screen and then
click Save to display the image again.

-- When an opportunity is created for a system-
generated view with filters applied, the filter
now persists across the view displayed in the
Aggregated tab from the Opportunities page.
The filter is not reapplied on the view from the
Opportunities page and the No recording
data message is no longer displayed.

-- When you now cancel a recording, the recording
is not displayed on the process tile in Process
Cycle.

-- You can now approve a recording with 2000
steps. The Recording status is displayed as
approved.

Известные ограничения

Actions such as double-click, drag-drop, click and hold, and text select are not supported when you
are recording a business process.

IQ Bot

Новые функции

Support for variables in IQ Bot actions (Service Cloud case ID: 00511178)
IQ Bot On-Premises and Cloud
You can now use variables in the Download all documents and Upload Document actions in
the IQ Bot пакет.
Create a variable | IQ Bot пакет

Измененные функции

Rename a learning instance (Service Cloud case ID: 00675803)

You can now rename a learning instance in staging in IQ Bot.

Последовательная обработка документов (ID обращения к облачному сервису:
00662968, 00665331)
When you click See Extraction Results, IQ Bot now opens that request in a new browser tab
where its number in the queue is displayed. This number keeps decreasing as the previous requests
in queue are processed.
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Измененные функции

Dutch language support
IQ Bot теперь поддерживает нидерландский язык с ABBYY FineReader Engine.

Configure OCR settings using REST APIs
A user with AA IQ Bot Administrator role can now use the appConfigurations API to read and
update the OCR settings.
Select an OCR engine

Исправленные функции

ID обращения к облачному сервису Описание

00639117 Numeric format in the Polish language is now
accepted in the IQ Bot Валидатор.

-- When you upload a document immediately after
deleting a бот it was associated with, extraction
results are now displayed irrespective of when
the бот was deleted. Previously, an interval of
3 minutes was required to view the extraction
results of the deleted бот.

00636899, 00683451 При создании обучаемого экземпляра с
помощью пользовательского домена имена
полей теперь отображаются правильно,
независимо от языка пользовательского
домена.

00459301, 00677204, 00532325, 00658245 Пользовательская логика Python теперь
отображает результаты извлечения в окне
Designer без ошибок.

00657928, 00679540 Exported IQ Bot archive (.iqba) files no longer
contain any unclassified records in the .csv files.

00704365 If documents uploaded during production have
fewer pages than the staging documents that
the бот was trained with, these production
documents are now processed without any
errors.

00703560, 0062442 When you migrate learning instances using the
append option, all records are now correctly
migrated, irrespective of the number of records
in the IQBA file.

00715124 IQ Bot now deletes temporary files downloaded
from Amazon S3 server in the C:\windows
\temp\ folder when they are no longer
required. As a result, storage is no longer
consumed by these temporary files.

00686297 Теперь службы машинного обучения IQ Bot
правильно устанавливаются при установке IQ
Bot.
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Исправленные функции

ID обращения к облачному сервису Описание

00657928, 00679540, 00727633 You can now migrate learning instances to
production, even if they contain unclassified
documents.

Известные ограничения

IQ Bot On-Premises and Cloud
If you click See Extraction results multiple times, the Learning instances listing page is
opened instead of the extraction results.

IQ Bot On-Premises and Cloud
When creating a table on the Designer page, if you click See Extraction results without
completing the table creation, extraction results are not displayed.
Обходное решение. Create the table first and then click See Extraction results.

IQ Bot On-Premises and Cloud
An error message is displayed when you refresh the extraction results page for a learning instance
when the associated бот is moved to production.

IQ Bot On-Premises and Cloud
When a бот is deleted, an incorrect error message is displayed when you click the Test bot option
on the Bots listing page.

IQ Bot On-Premises and Cloud
If you rename a learning instance in production and download the files, all the files associated with
the original learning instance are also downloaded. For example, if you rename a learning instance
from Sales1 to Sales2, all the files associated with Sales1 are also downloaded when you download
Sales2.

IQ Bot On-Premises and Cloud
If you have multiple learning instances and you click See Extraction results for all of them, the
extraction results are not processed in the order of their request.

IQ Bot On-Premises and Cloud
When you create a learning instance with check box fields and run a Python script associated with
the check box, an error message is displayed on the Designer page.

IQ Bot On-Premises and Cloud
Когда вы загружаете в обучаемый экземпляр документы промежуточной или
производственной среды, в папке C:\Windows\Temp создаются временные файлы, и с
течением времени размер папки может увеличиваться. Поэтому вручную удаляйте файлы из
этой папки, так как это может привести к тому, что IQ Bot перестанет отвечать.
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Известные ограничения

IQ Bot On-Premises and Cloud
If you select the Only for me option when installing the Bot Agent, the IQ Bot Extraction action
has the following issues:
• Takes a very long time to process a document.
• Some of the documents might not be processed successfully.

Обходное решение. During Bot Agent installation, choose the Anyone who uses this
computer (all users) option.

IQ Bot On-Premises
(ID обращения к облачному сервису: 00762174) Using the Database Migration Assistant to
migrate from IQ Bot 11.x (five databases) to A2019 (unified database) in Microsoft Azure Database
is not supported.

IQ Bot On-Premises and Cloud
When you change the display language of any learning instance that has a document in
Валидатор, although the selected display language is successfully applied to the learning instance,
an error message is still displayed.

IQ Bot Cloud
The auto-correction and auto-suggestion features, which are part of the MLScheduler service, use
system resources extensively and cause the system to slow down or stop responding.

Deprecated features

IQ Bot On-Premises is no longer supported on Windows Server 2012.

Bot Insight

Исправленные функции

ID обращения к облачному сервису Описание

00669196 When you apply date filters on a dashboard and
then apply an attribute filter in the widget, the
system now filters by a specific date. Previously,
the date filter applied at the dashboard level was
ignored when the attribute filter was selected at
the widget level. As a result, historical data was
also displayed.

Важное замечание:  The supported packages information is moved to this topic: View пакет versions
available in the Control Room.
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Enterprise A2019.18 Release Notes
Дата выпуска: 11 January 2021

Review the new features, changed features, fixed features, known limitations, and supported пакеты in
the Enterprise A2019.18 (Сборка 7560) release. For IQ Bot, Build 7553 is available for Cloud customers
and Build 7554 is available for On-Premises customers. There are no security fixes in this release.

Важное замечание:  We have updated Enterprise A2019.18 to Сборка 7560 to include fixes for issues
with workload management (Service Cloud case IDs 00696614 and 00703339) and SSO authentication
on Automation Anywhere Cloud (Service Cloud case IDs 00706042, 00706074, 00706201, 00706195,
00706134, 00706022, and 00707033). See the Fixed features section for more information.

• Особенности миграции
• Enterprise A2019
• AARI
• Discovery Bot
• IQ Bot
• Bot Insight
• Поддерживаемые пакеты

Особенности миграции

Особенности Enterprise 11 и Enterprise 10

Migrate MetaBots with screens
Migrate MetaBots that contain screens as assets. You can migrate screens based on HTML, MSAA,
and .NET technologies and captured using the Object, Image, and Coordinate play modes.

Configure timeout in Бот Migration пакет
When migrating боты, you can now set a timeout value in the range of 3 through 90 minutes
(default value is 90 minutes). If the migration of any specific бот is not completed within the set
time, a timeout message is displayed and the migration process moves to the next бот.

Use regular expressions in variables (Service Cloud case ID: 00628227)
Use regular expressions (regex) in value type variables to specify the entity on which you want to
perform an operation. For example, actions in the Файл, Папка, Строка, and Окно пакеты allow
use of regular expression in variables.
When Enterprise 11 or Enterprise 10 боты with commands that use regular expressions in variables
are migrated, if their equivalent actions in Enterprise A2019 do not support regular expressions, the
regular expression is converted to string in the migrated боты.

Migrate MetaBot that returns a list variable
You can now migrate MetaBots that contain logic that return a list variable to the parent бот.

Migrate боты that use functional keys
Migrate боты that use functional keys such as F1, F2, and F3 in the Send Text command.
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Особенности Enterprise 11 и Enterprise 10

Migrate боты that extract information from PDF
Migrate боты that use the Extract Form Fields command to extract data from the fields in a PDF
file.

Только для Enterprise 11

Migrate боты to Enterprise A2019 Cloud
You can now migrate to Enterprise A2019 Cloud by using the Cloud Migration Utility. Use the utility
to upload your Enterprise 11 data to Automation Anywhere Cloud.
Migrate from 11.x to Cloud

Migrate to Enterprise A2019 on Linux CentOS (Service Cloud case ID: 00654757)
You can now migrate from Enterprise 11 to Enterprise A2019 installed on Linux CentOS.
Migrate to Linux CentOS

Migrate imported Enterprise 11 боты to Enterprise A2019
You can now migrate Enterprise 11 боты that you imported using the Bot Lifecycle Management
feature or the Import API to Enterprise A2019 by using the migration wizard.

Migrate боты that use the following attributes:
• Боты that use regular expression (regex) to search for the string and title of an application

window on which you want to perform an operation
• (ID обращения к облачному сервису: 00616115) Боты for which custom format is

configured for system dates
The system uses the AADefaultDateFormat global value to store the format of the date.

• Боты that use the Search Field command to search a field index or field name by using text in
the Эмулятор терминала

Enterprise A2019

Важное замечание:  This release includes a required update to your . Ensure that you complete the
update to continue with your automation activities when upgrading from a previous release to this release.

Автоматическое обновление Bot Agent | Обновление Bot Agent вручную

To verify which  version is compatible with this release, see Compatibility with release builds.
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Новые функции

Create a Непрофессиональный разработчик user
Administrators can now use the Непрофессиональный разработчик license to create
Непрофессиональный разработчик roles and users in the Control Room. Пользователи с
этой лицензией могут создавать и запускать боты (включая боты с триггерами) на своих
устройствах.

Лицензии Automation 360 | Create a Непрофессиональный разработчик role | Create a
Непрофессиональный разработчик user

Средство записи enhancements
• Use the AISense Recorder Define option to record an interaction, such as click active text, with

an object that is only visible when you hover the mouse over the object.
• If you record a click and keystrokes in a text box with a Control Type of PASSWORD_TEXT,

the Recorder does not capture the keystrokes entered into the field. Instead, the action selects
the Set text option and offers users the option to select a credential from the Credential Vault,
enter a credential variable, or enter an insecure string.

Export and import Bot Insight dashboards using Bot Lifecycle Management
The Bot Lifecycle Management feature now enables you to export and import Bot Insight
dashboards (default, custom, and published) associated with analytics боты from one Control Room
instance to another. You can also export and import Bot Insight dashboards using the Bot Lifecycle
Management export and import APIs.

Экспортировать боты | Импорт боты

Support for non-persistent VDI
Non-persistent virtual desktop infrastructure (VDI) is now supported for temporary devices so
that you can configure settings for temporary devices in the Control Room or during Bot Agent
installation.
The feature includes the following capabilities:
• Automatically register a device.
• Automatically mark a device as default for the logged-in user.
• Automatically add a device to an existing pool.
• Delete offline devices from a list of devices.
• Add parameters for temporary devices in the Bot Agent MSI file.

Manage device settings | Configure temporary devices | Bulk install Bot Agent on devices

Efficiently map input and output variables between parent and child боты (Service Cloud
case ID: 00537090, 00698697)
For input variables, use the Quick map option to select the variables and set the values for
the parent бот to pass. For output variables, use the Multiple variables tab to associate each
dictionary key with a variable. This feature eliminates the need to use actions to extract the output
dictionary values.
TaskBot пакет | Using the Run action
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Новые функции

Support for PowerBuilder application in Интеграция приложений пакет (Service Cloud
case ID: 00680703)
The Интеграция приложений пакет now supports PowerBuilder to capture and extract text from
a window application. The Capture text of window action enables you to open a PowerBuilder
screen to capture all the data and verify the captured text.

Enhancements to check-out option in the private workspace
• The My bots page in the private workspace displays a new status Checked out edited for

боты that are checked out and edited.
• Use the Revert edits option to cancel any changes you made to the checked-out бот in the

private workspace.

Programmatically delete боты, files, and folders
Use the Delete files/folders API to delete objects from the private or public workspace.
DELETE <control_room_URL>/v2/repository/files/{id}

Manage scheduled боты using APIs
Use the Bot Scheduler APIs to create, update, and view details, and delete бот schedules.
Боты can be scheduled to run at a specific date and time on an unattended Bot Runner, or on a
recurring basis.

Новое action в пакет Эмулятор терминала
Use the Search Field action in the Эмулятор терминала пакет to search for a field based on the
text it contains. This action returns the name or index of the field based on the option selected.
Terminal Emulator пакет

Новое action в пакет PDF
Use the Get Property action in the PDF пакет to retrieve the properties of a PDF file and assigns
the properties to a dictionary variable.
Using the Get property action

Новое actions в пакет Браузер
Use the following actions in the Браузер пакет:
• Close: Closes a Google Chrome browser window or tab.
• Get source code: Извлекает исходный код веб-страницы и сохраняет его в строковой

переменной.
• Go back: Возврат на веб-страницу, которую вы ранее посетили на текущей вкладке.
• Open: Opens the browser to a specific web page in an existing tab, new tab, or window.
• Run JavaScript: Executes JavaScript in a web page.

Браузер пакет
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Новые функции

Specify application window dimensions
Use the Resize windows option to set the window height and width to specific dimensions or
to the dimensions at which it was captured. This feature enhances the bot's ability to identify the
target object.
The following пакеты support this feature:
• Интеграция приложений
• Если Image recognition condition
• Если Legacy Automation > Window Control condition
• Распознавание изображений
• Имитация нажатия клавиш
• Legacy Automation Desktop > Manage windows controls action
• Цикл While > Image recognition condition
• Цикл While > Legacy Automation > Window Control condition
• Мышь
• Распознавание текста (OCR)
• Экран

Support for function keys in Эмулятор терминала пакет
Function keys (F1 through F24) are now supported to automate processes using ANSI and VT100
terminals in the Эмулятор терминала пакет.

Use regex case insensitive flag for Window title
Enable the regex Case insensitive flag to identify a Window title field as not case-sensitive.
This feature enables you to successfully run the боты even if the letter case does not match the
captured window title.
The following пакеты and actions support this feature:
• Ожидать
• Распознавание изображений
• Имитация нажатия клавиш
• Мышь > Click action
• Legacy Automation Desktop > Manage windows controls
• Распознавание текста (OCR) > Capture window, Capture area
• Экран > Capture window, Capture area
• Средство записи > Capture
• Окно: Activate, Close, Maximize, Minimize, Resize

Unattended Bot Runner supported on Citrix devices
You can now deploy боты on unattended Bot Runner on virtual machines on Citrix XenDesktop and
Citrix VDI Windows 2016.

Измененные функции

Only Bot Scanner related files and folders are deleted
The Bot Scanner now deletes only Bot Scanner related files and folders from the destination folder.
Scan Enterprise 11 or 10 боты using Bot Scanner
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Измененные функции

Enhanced transport layer security (Service Cloud case ID: 00677546, 00681830)
The default Elasticsearch ports (47599, 47600) now use the more secure TLS version 1.2 and later
as the communication channel between the Control Room and Elasticsearch server.

Enhanced Update node action in XML пакет (Service Cloud case ID: 00663089)
When you edit and save an XML node, the бот updates the required attributes and their values in
an alphabetical order, without removing any existing attributes of the node.
For example, consider two existing attributes in an XML node such as Name=Peter and
Phone=9829xxxxxx. If you change the value of the phone attribute as 9887xxxxxx and add a
new attribute Gender with value as Male, the бот updates the phone value and adds the gender
as a new attribute, without removing the existing name attribute.

Interface change in Базовый Excel and Расширенный Excel пакеты
The session name field is now the last field in actions in the Базовый Excel and Расширенный
Excel пакеты.

Access at subfolder level in Control Room repository (Service Cloud case ID: 00634847,
00681221, 00685654)
An administrator can now allow access at the subfolder level in the Control Room by assigning the
Run, Check-in and Check-out permissions to the subfolder. You can only access the contents of
the subfolder and not the other боты or files in the parent folder.

Increased working area in the Bot editor
More horizontal and vertical screen area is available in the Bot editor for developing боты. You can
hide or display the Actions and Details panels to maximize the working area in the Bot editor.

The following table lists the fixed features and the builds in which they were fixed (Сборка 7560 is the
latest build, and Build 7554 is the previous build). The fixes are cumulatively available in the latest build.

Исправленные функции

Build number ID обращения к
облачному сервису

Описание

7560 00696614 Бот deployment is no longer delayed after you
insert Work Items if idle devices are available
for the deployment in queues.

7560 00703339 The post Work Item insertion flow is now
improved so that бот deployments are not
delayed.

7560 00706042, 00706074,
00706201, 00706195,
00706134, 00706022,
00707033

An issue with Control Room login page not
supporting SAML for SSO and reporting an
errant IPD response has been addressed. The
SSO function of the Control Room login works
as expected.

7554 00659336 Enterprise 11 боты that use the
Распознавание изображений command or
Image Recognition condition of the Если
command now run successfully after migration.
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Исправленные функции

Build number ID обращения к
облачному сервису

Описание

7554 00647634 The Bot Scanner no longer becomes
unresponsive when scanning a large repository.

7554 00678614 An error is no longer encountered when
you migrate a бот with a credential name
that contains a space character or a special
character.

7554 00669247 An error is no longer encountered when you
download a file from a URL that contains a
Unicode character using the Download files
action of the Браузер пакет.

7554 00685916 If you have used the Date system variable
as an input variable in a MetaBot, the
Date system variable is now available after
migration.

7554 00674594 The Bot Scanner no longer encounters an
error when scanning a бот that uses the
Excel Column system variable after the Цикл
command and the column name specified in
that variable contains a space character.

7554 00691905 An error is no longer encountered when you
edit a user after migrating to Enterprise A2019
from Version 11.3.3.

7554 00691072 An error is no longer encountered because
of the bypass configuration of proxy settings
when you use the Bot Migration Wizard.

7554 00689910 You can now import more than 2100 бот files
without any SQL exception error.

7554 00669927 When you execute the Bot Insight Business
Data and Operations Data APIs, only
information limited to the logged-in tenant is
now retrieved in the API response.

7554 00639779 After you log in to the Control Room and
connect manually to a VPN, the Bot Agent now
reconnects automatically. You do not have to
restart the Bot Agent service to reconnect.

7554 00622075 When you run a бот on a user device that has
an extended display, the runtime window is
now completely visible on the main display.
Previously, the window was partially visible
between the main and extended display.

7554 00678454 In Расширенный Excel, you can now use
the Set cell action to write more than 4100
characters in the excel file. Previously, the бот
execution failed when the cell value had more
than 4100 characters.
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Исправленные функции

Build number ID обращения к
облачному сервису

Описание

7554 00675333 In the Число пакет, the field in the Assign
action is now corrected as Select the source
number variable/ value. Previously, the
Select the source string variable/ value
field was incorrect.

7554 00674315, 00677925,
00684201

When you create a TaskBot using the If and
Else if actions and change the placement of
the Else if block action, there is improved
visibility in the Flow view. Previously, the
TaskBot was not displayed properly on a
low contrast display when the Else if block
placement was changed.

7554 00662072, 00674336 In the Эмулятор терминала пакет, you
can now correctly page up using the
KEY_PGUP function key and page down using
KEY_PGDOWN for the TN5250 terminal type.

7554 00658261 The PDF Extract image action now supports
CMYK (cyan, magenta, yellow, black) images
format when you extract and save a CMYK
image to an RGB (red, green, and blue) image.
Previously, if PDF files contained CMYK images,
the бот could not extract them and displayed
an error.

7554 00675749 When you receive emails using the EWS server
option, the emailCc and emailTo variables
now return the proper value. Previously, these
variables returned blank values.

7554 00663610 In the Ftp/Sftp пакет, you can now connect to
ftp.box.com and use the Get folder action.
Previously, the Get folder action downloaded
files in the folder, causing the бот to run in an
infinite loop.

7554 00675710 In the Таблица данных пакет, the Remove
duplicate rows action now removes all
duplicate rows rather than a single duplicate
row.

7554 00539762 In the For value action of the Запрос
пакет, characters are no longer visible during
keystrokes of masked values.

7554 00679370, 00673085,
00674546, 00676912,
00678852, 00678796,
00692420, 00695390

An unknown error is no longer encountered
when you run the Open Excel file action from
a network drive.
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Исправленные функции

Build number ID обращения к
облачному сервису

Описание

7554 00672719, 00673048 Audit log entries in the Control Room are
now retained even if the Elasticsearch data
is configured to a file path other than C:\ (C
drive) during installation.

7554 -- You can now insert Work Items from one
queue to another queue for workload
automation.

7554 -- You no longer have to pause and resume
queues because Work Items are now
processed and not randomly skipped when you
use the priority queuing or round-robin method
for workload automation.

7554 -- The Средство записи пакет no longer
takes time to upload to a remote application
repository path of an On-Premises Control
Room deployed on Microsoft Azure.

7554 00683744 You can now capture objects from the Google
Chrome browser using the Средство записи
capture action. The plug-in not installed or
disabled error is no longer displayed.

7554 00672446, 00671782,
00671065, 00683870

When you upgrade to this release from
an earlier release (for example, Enterprise
A2019.16), the Elasticsearch OpenDistro error
message is no longer displayed. Also, the
previous application_log indices from
Elasticsearch are deleted to free up disk space
for the upgrade.

7554 00690003 You can now use the Эмулятор терминала
пакет without any change in the screen
resolution for the mainframe terminal type
TN3270. Previously, the screen resolution was
not supported for terminal type TN3270.

7554 00679244 In Словарь and Список пакеты, you can now
use the Datetime data type in the source
dictionary variable field of the Assign action.
Previously, an error was encountered during
бот execution if you used Datetime data type
in the source dictionary variable field.

7554 00673591 Fixed an issue in the TaskBot пакет where the
system selected all the input variable options
when the user clicked away from and returned
to the action.

7554 00684905, 00703481 A TaskBot now runs as scheduled and no
longer shows the device status as Picked
at runtime on the View task in progress
(Activity) page when the TaskBot is running.
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Исправленные функции

Build number ID обращения к
облачному сервису

Описание

7554 00573081 The audit log page in the Control Room now
records all entries related to бот deployment.
Also, when a parent task with many child боты
is deployed, the audit log now shows correct
entries. Previously, some audit log entries were
missing for бот deployment and if a parent
task with many child боты was deployed, the
entries displayed were incorrect.

Известные ограничения

Enterprise A2019 does not yet support the counter behavior of the $Excel Cell Row$
system variable in Enterprise 11 when the variable is used in the Цикл command and
the Each row in Excel Dataset option is selected. This behavior is available in 11.3.0
and earlier versions by default, and in the Version 11.3.1.2 and later versions when the
retainexcelcellrowlegacybehavior tag in the AASettings.xml file is set to true.

A бот fails when it runs an action that reloads the web page, such as the Recorder > Capture
action when it is used to click a link or the Browser > Open action, followed by a Browser >
Run JavaScript or Browser > Extract source action.
You must add a delay of at least 5 seconds to give the browser time to load.

A бот fails when it runs the Browser > Close action to close the last Google Chrome window and
the window contains only one tab.
Use the Tab or All browsers options instead.

A бот can return only a maximum of 3 MB to an output variable.
Обходное решение. Store the бот output on the device, such as in a .txt file. If the output must
be shared across multiple Bot Runner, store the output in a shared drive.

The AISense Recorder fails if you manually upgrade the Средство записи пакет version, such as by
importing a бот that contains a Средство записи пакет version from a more recent build than the
destination Control Room. Always upgrade the Средство записи пакет through the Control Room.

If you install the Google Chrome extension in the Microsoft Edge browser, it causes recording and
runtime errors in боты that interact with the Google Chrome browser. Even if you did not manually
install the Google Chrome extension, the auto-sync settings in the Microsoft Edge browser might
have automatically installed the extension.
If the Google Chrome extension is installed in the Microsoft Edge browser, you must remove the
Google Chrome extension from the edge://extensions page.

When the regex Case insensitive flag is enabled for actions that include the window title, a
recapture of the application window fails.

The input parameters for DLLs are not automatically passed from the parent бот to the child бот in
Enterprise A2019 for migrated MetaBots.
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Известные ограничения

Workload automation limitation for manual Credential Vault mode (Service Cloud case ID:
00711410)
You might face issues when migrating your workload automation if the Control Room is configured
to use a manual mode for Credential Vault.
Обходное решение. As the Control Room administrator, perform the following steps:
1. Change the Credential Vault mode to express from manual in the Control Room database

configuration table.
2. Add the credential vault key to the CredentialVault.dat file in the Control Room server

repository.
3. Restart the Automation Anywhere Control Room Service.
4. Re-register the Bot Agent or restart the Bot Agent service.

Cloud migration limitations
• The Cloud migration utility keeps running in background if you close the utility when the

Enterprise 11 data is being uploaded.
• If you have configured Enterprise 11 Control Room in cluster mode, you must stop the

Automation Anywhere Control Room Service on all the nodes available in the cluster.
• If the Cloud migration utility is installed on a different device than the device on which the

Enterprise 11 Control Room you want to migrate is installed, an Elasticsearch unavailable error
occurs.

• If you have SSO configured on the Enterprise 11 Control Room, an error is encountered after
migration to Cloud if you change the authentication from database to SSO.

• If you provide the validation code within double quotation marks, the utility successfully
validates the code but fails when uploading the Enterprise 11 data.

If you open a table variable for editing and then open another table variable and click Cancel in
the Edit table window, the schema of that table reverts to the same schema of the first table. This
occurs only in the interface; it does not impact the бот.
Обходное решение. Refresh the window containing the Control Room.

If you use different versions of a пакет in a parent бот and a child бот, the capability to share a
session across боты is currently not supported in the following пакеты: DLL, Расширенный Excel,
Базовый Excel, and Эмулятор терминала
To share a session across parent and child боты, ensure that you use the same version of the
package in both the parent and child боты.

Automation Anywhere Robotic Interface (AARI)

Новые функции

New AARI on the web пакет
Use the AARI on the web пакет to perform actions such as assign, query, and cancel tasks; create
and query requests; and retrieve a list of team members.
AARI Web пакет
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Новые функции

Filter by time
You can now filter your requests and tasks by time:
• Requests tab: Use the Created and Updated options in the Filter window to select any

dates.
• Tasks tab: Use the Task created and Task updated options in the Filter window to select

any dates.

Filter and search for a request | Фильтрация и поиск задач

View updated dates
• Use the new Updated column in the Requests tab to view the dates and time of a request

that was last updated.
• Use the new Task Updated column in the Tasks tab to view the date and time of a task that

was last updated.

Variable options
In the Insert a variable window, the Variable field now shows child elements of available
references, which include Dictionary, List, Record, and Table variable types.

Delete a request
AARI administrators, managers, and users can now delete requests created by the AARI process.
The AARI administrator can delete any requests. AARI managers can delete requests of the team
for which they are the owner. AARI users can delete only the requests they have created.
Delete a request

Automatically assign managers and users
Users can now select the Auto assign this task option in the Human Task to assign managers
or users to the task. Users can also select the Auto assign the target task to option in the Go
to element to assign managers to the task.

Создание процесса AARI

Enhancements to elements in the form builder
• Time element: Includes the time element in a form.

Using the Time element
• Date element: Set the date format of the user machine as the default format for the date

element in the form.
Using the Date element

• Select file element: Drag the selected file into the form during бот runtime.
Using the Select File element

• Password element: View the password you enter in this field during бот runtime.
Using the Password element
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Новые функции

Updates to interactive forms
• Use the Change Form Title to edit or change the title of the selected form during бот runtime.
• Use the Validate form option now for the Table element.

Interactive forms пакет

Измененные функции

Process пакет renamed to AARI on the web пакет
The Process пакет is now renamed to the AARI on the web пакет, which includes the Create a
Request action and additional new actions.
AARI web package

Enhancement to process management page
In the process management page, the AARI admin can now edit the Process Title and Process
Description metadata. You can now add a title and provide a short description for the process.

Enhancement to the activity page
All the Bot Runner (attended or unattended) trigger deployments in queue are now displayed in the
Activity > In progress page.

Действия

Edit check box, radio button, and drop-down form elements in process editor
In the process editor, you can now edit and update the List of options and Default value fields
for the following form elements: Checkbox, Radio button, and Dropdown.

Исправленные функции

ID обращения к облачному сервису Описание

00678572 You can now view the strict-transport-
security header when using the AARI on the
web interface. This attribute informs the web
browser to automatically convert websites
requesting HTTP to load HTTPS instead in
order to comply with the HTTP Strict-Transport-
Security (HSTS) policy.

-- The Display message field in the If/Else
pair action now displays the status message in
request view. Previously, the status message was
not displayed in the request view.

-- When you access AARI through the web
interface, the Request ID and Task ID now
correctly identify the data as numeric data type
and sort it accordingly. Previously, the data was
considered as string type and the sorting was
not appropriate.
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Исправленные функции

ID обращения к облачному сервису Описание

00646148 A бот is no longer deployed multiple times when
the files and folders triggers are used.

Известные ограничения

When a user with a Непрофессиональный разработчик license deletes an event trigger, this
activity is not captured in the Audit log tab.

When you delete a request from the Request tab, the tasks associated with the request are not
deleted and they are displayed in the Tasks tab.

If you click the refresh option in the Tasks tab and navigate away and back to the tab, the task
filter applied does not remain the same. The filter always switches to Pending status.

Discovery Bot

Новые функции

Use Model option for system-generated views
You can now use the Model option to compare and find the best aggregated view for your
recordings. Use this option to save as many views with different combinations as required.
You can also save the view as a manual view to further customize your view and compare side-by-
side. Select either an Easy or Strict model so that you can view recordings where the steps are
the same versus recordings with different results with more branches in the process path.
Create a process view with branches and opportunities

Use Filter option for system-generated views
You can now use the Filter option to use a set of values to compare different sections of a process
across various recordings by selecting a specific path and step filter. Used along with the Model
option, the path and step filter options for a system-generated or manual view can help you to
determine and decide on a good candidate for automation.
Create a process view with branches and opportunities

Use toggle frequency counter option for system-generated views
You can now use the toggle frequency counter to display the number of recordings that a particular
path takes in the flow in a system-generated view. Use this option to help you understand the
frequency of the path compared to other recordings or views.
Create a process view with branches and opportunities

Remove recording screenshot for data privacy
Use the Screen option (icon) to display or hide the recording screenshot before submitting the
recording for the analyst to review. Use this option when you do not want to share personal image
details with the analyst.

Запись бизнес-процесса Discovery Bot
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Новые функции

Download PDD from the Opportunities table
You can now download a process definition document (PDD) for an opportunity directly from the
Opportunities table listed on the Opportunities page. The PDD is automatically generated when
the opportunity is created. After the PDD is generated, the field changes from generating PDD to
Download PDD. You can then download and save the document.
Review opportunities and convert to

Измененные функции

Screenshot image is increased
The screenshot image is now increased to allow for better readability of captured steps. You can
now use the scroll wheel to get a zoomed-in view of the step.

The Export to Word option now supports 2000 steps.

The Convert to Bot option now supports 2000 steps.

Исправленные функции

ID обращения к облачному сервису Описание

-- The Delete icon is now properly visible in the
edit recordings screen in Internet Explorer.

-- You can now change the zoom level in any
canvas using the two-finger swipe on the
trackpad of the Aggregated and Comparison
tabs.

-- The red highlight is now visible on the captured
screenshots from the Recordings page and
from the preview pane from the Aggregated
and Opportunity tabs for analyst review.

Известные ограничения

When upgrading to this release, you must regenerate all PDDs created in Enterprise A2019.17. Click
Retry PDD Generation to regenerate the PDDs.

If you want to display an image that you have hidden and saved, you must first click the Screen
icon and then click Save to display the image again.

In the Opportunities table, the search field and filter drop-down option are not available for the
Process and Owner columns.

When an opportunity is created for a system-generated view with filters applied, the filter is
reapplied on the view displayed within the Aggregated tab from the Opportunities page. The filter
incorrectly displays No recording data. The Convert to Bot and the Download PDD options
are not affected.

When a recording is canceled, the recording is incorrectly incremented and displayed on the
process tile in Process Cycle.
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Известные ограничения

You cannot approve a recording with more than 500 steps.

IQ Bot

Новые функции

New IQ Bot Extraction пакет
On-Premises и Cloud
IQ Bot now includes the IQ Bot Extraction пакет for processing invoices. The пакет uses Bot
Runner on your local device instead of an IQ Bot server for processing.
IQ Bot Extraction пакет

Измененные функции

Усовершенствование утилиты миграции
Когда вы теперь экспортируете файл архива IQ Bot (.iqba), экспортируется только один
документ, связанный с каждым доступным (групповым) обучением бот.

Усовершенствование пакет IQ Bot Classifier
The IQ Bot Classifier пакет now supports all languages supported by ABBYY FineReader Engine.
Previously, only English language was supported.
ABBYY FineReader Engine OCR supported languages

Исправленные функции

ID обращения к облачному сервису Описание

00668625 When you upload documents containing digital
signatures to learning instances, the Designer
now displays the correct success or error
message.

00619139, 00695157 When you now run a бот and try to edit it while
it is still running, the following correct message
is displayed: Staging Documents for this
Vision bot is in progress. Please
try after some time. Previously, the
following incorrect message was displayed:
Learning instance not found.

00408482 Теперь вы можете успешно экспортировать
пользовательский домен, созданный с
помощью корейского или другого азиатского
языка.

00669197, 00681599 Node.js is now upgraded to version v10.22.1 to
fix a security vulnerability.
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Исправленные функции

ID обращения к облачному сервису Описание

-- Fixed an issue that caused the following error:
failed to upgrade DB -1. You can now
install IQ Bot in express mode without any
errors.

00633197 During validation, if there is an error in the
validation pattern, the validation process now
fails, the correct message is displayed, and error
logs are generated.

00689326 You can now view the extraction results correctly
even when the бот is trained with check box
fields.

00666456 Теперь службы машинного обучения IQ Bot
правильно устанавливаются при установке IQ
Bot.

Известные ограничения

IQ Bot On-Premises and Cloud
The following limitations apply to the IQ Bot Extractionпакет:
• If you process documents that do not belong to any created groups, they are not displayed in

the Details page of the learning instance.
• The Checkbox extraction option is not supported.
• Some of the input invoices are not processed when you set up workload management with

shared input and output folders.
• Pre-processing settings from IQ Bot server are not applied.

IQ Bot On-Premises and Cloud
When creating learning instances, IQ Bot sometimes does not restrict users from creating duplicate
fields.

IQ Bot On-Premises and Cloud
Occasionally IQ Bot fails to execute Python logic for tables other than the default one.
Обходное решение. Retry after you perform one of the following actions:
• Click Save and close.
• Click See Extraction results.

IQ Bot On-Premises and Cloud
In PDF documents containing multiple pages, at times the segments do not display correctly on all
pages.
Обходное решение. Use PDFBox OCR to process the documents.
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Известные ограничения

IQ Bot On-Premises and Cloud
For the Get page content action of the IQ Bot Pre-processor пакет, if you select the Create
variable option from the List of strings extracted from page menu, you can only use Any
from the Subtype drop-down menu.

IQ Bot Community Edition, On-Premises and Cloud
If you use Internet Explorer version 11.0.973.17763 to log in to IQ Bot and open See extraction
results for a learning instance, you cannot open or download the Preview.csv file.

IQ Bot On-Premises
You must be a service account user to install IQ Bot on a fresh machine.

IQ Bot On-Premisesand Cloud
The auto-correction and auto-suggestion features, which are part of the MLScheduler service, use
system resources extensively and cause the system to slow down or stop responding.

Bot Insight

Новые функции

Access Bot Insight data from Tableau
Use the Tableau connector in Bot Insight to access business and operational information. The
Tableau connector connects to the Bot Insight APIs to create various business and operational
metrics that you can analyze and visualize within Tableau.
Configure Tableau web data connector in Bot Insight

Assign Bot Insight license (Service Cloud case ID: 00651973)
Assign the Bot Insight license to users to enable them to view and perform tasks on the Business
dashboard. You can now assign the license on a per-user basis, irrespective of the assigned roles.

Лицензии Automation 360

Исправленные функции

ID обращения к облачному сервису Описание

00689802 You no longer encounter an issue when you
create and view default dashboards in a
development (dev) environment. Previously, an
error was displayed when you open the бот and
clicked Analyze to create the default dashboard.

Поддерживаемые пакеты

Пакет Версия

Приложение 2.1.0-20201112-22332
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Пакет Версия

Интеграция приложений 2.3.0-20201210-171315

Active Directory 2.1.0-20201112-223323

Логический 2.1.0-20201126-165109

Браузер 2.3.0-20201211-222811

Буфер обмена 2.1.0-20201126-165124

Комментарий 2.3.0-20201126-165125

CSV/TXT 2.3.0-20201126-165126

База данных 2.2.0-20201112-223343

Таблица данных 2.5.0-20201201-130615

Дата/время 2.2.0-20201126-165136

Задержка 2.2.0-20201126-165137

Словарь 3.2.0-20201126-165138

Run DLL 3.3.0-20201126-165850

Эл. почта 3.2.0-20201120-062604

Обработчик ошибок 2.3.0-20201126-165148

Базовый Excel 2.4.0-20201126-165604

Расширенный Excel 5.3.0-20201208-090251

Файл 3.2.0-20201126-165151

Папка 3.1.0-20201126-165154

FTP / SFTP 2.2.0-20201115-072759

Распознавание изображений 2.2.0-20201117-081754

JavaScript 2.4.0-20201126-165412

Имитация нажатия клавиш 2.5.0-20201112-223902

Legacy Automation 3.2.0-20201124-064544
1.5.0-20201125-004358

Список 2.2.0-20201126-165427

Записать в файл 2.2.0-20201126-165428

Цикл 2.1.0-20201126-165429

Message Box 2.1.0-20201126-165430

Мышь 2.2.0-20201112-223917

Число 2.1.0-20201126-165444

Распознавание текста (OCR) 2.3.0-20201126-081210

Office 365 Excel 2.2.0-20201104-062559

Календарь Office 365 2.1.0-20201111-162101
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Пакет Версия

Office 365 OneDrive 2.2.0-20201126-165550

PDF 2.6.0-20201126-165555

PGP 2.2.0-20201126-165557

Ping 2.1.0-20201126-165559

Воспроизвести звук 2.1.0-20201127-115706

Запрос 2.2.0-20201109-192507

Python Script 2.4.0-20201208-064944

Средство записи 2,10-20201215-211402

Веб-служба REST 3.2.0-20201112-224735

SAP 2.2.0-20201126-165852

Экран 2.2.0-20201126-165855

SNMP 2.1.0-20201126-165859

Веб-служба SOAP 3.2.0-20201123-093411

Строка 3.1.0-20201126-165909

Система 3.0.0-20200921-090225

Эмулятор терминала 3.6.0-20201213-084139

VBScript 2.4.0-20201208-065526

Ожидать 3.1.0-20201126-165922

Окно 2.3.0-20201123-093430

Рабочая нагрузка 2.1.0-20200825-071644

XML 2.1.0-20201126-165927

Ссылки, связанные с данной
Заметки о выпуске Community Edition A2019.18

Enterprise A2019.17 Release Notes
Дата выпуска: 2 декабря 2020 года
Review the new features, changed features, fixed features, security fixes, known limitations, and supported
packages in the Enterprise A2019.17 (Сборка 7103) release. IQ Bot is on Build 7082.
• Enterprise A2019
• AARI
• Discovery Bot
• IQ Bot
• Bot Insight
• Supported packages
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Особенности миграции

Важное замечание:  Migration to Enterprise A2019 (currently available only to customers in
the Migration Early Adopter Program)
Migration to Enterprise A2019 is currently only available to select customers through our Migration Early
Adopter Program. If you are interested in learning more about this program or a timeline for when
migration will be available to all customers, contact your Automation Anywhere representative.

The following features apply to both Enterprise 11 and Enterprise 10:

Obtain information about upcoming support
for commands and variables

Bot Scanner provides information about the
upcoming Enterprise A2019 release in which a
specific command or variable will be supported or
available.

Migrate MetaBots with screens Migrate MetaBots that contain screens as assets.
You can migrate screens based on the Java
technology and captured using the Object, Image,
and Coordinate play modes.

Как выполняется миграция MetaBots

View progress of бот migration A progress bar is displayed in the migration results
tab when the system starts migrating the боты.

Migrate боты that use SAP command You can migrate Enterprise 11 боты that use the
GUI Automation command to capture various
objects from an SAP application.

Сопоставление пакетов для миграции

Migrate боты that use the following
attributes:

• Regular expression to search for files on which
you want to perform an operation.

• Variable to specify the child бот you want to run.
• System variables to retrieve information about a

device's settings and its performance.
• The Save header To option and containing

array and dictionary variables in the Веб-служба
REST command to store the response header.

• Боты that contain failure responses from the
Веб-служба REST command by using the
Capture failure response option in Enterprise
A2019. For Enterprise 11 боты, this option is
enabled by default.

Веб-служба REST пакет
• Variables with names containing Arabic or

Russian characters, or Japanese double-byte
numbers.
Unicode range supported in variables

The following features apply to Enterprise 11 only:

Increment loop counter value by 1 The $Counter$ variable used in loop in Enterprise
11 боты is replaced with the $Condition-Counter

© 2023 Automation Anywhere. All rights reserved.     492



    Automation Anywhere - Learn

$ variable in the migrated боты and value for the
variable set to 1.
Service Cloud case ID: 00659314

View audit log migration reports View the status of audit log migration and other
related information in the All migrations page.
View additional information by using the View
migration option for each audit migration instance.

Миграция журналов аудита Enterprise 11 |
Просмотр отчетов о переносе данных

Migrate Enterprise 11 Bot Insight data and
dashboards

• Migrate Enterprise 11 Bot Insight data and
published dashboards of боты enabled for
analytics by using the Bot Insight pre-migration
utility and Bot Migration Wizard.

Экспорт информационных панелей Enterprise
11 Bot Insight для миграции | Миграция
корпоративных боты

• View Bot Insight migration reports from
the new Bot Insight results tab on the
Administration > Migration > View
migration page.

Просмотр отчетов о переносе данных

Migrate боты that use the following
attributes:

• MetaBots with DLLs that use credential variables
of string, character, or byte data type.

• The Launch website action of the Браузер
пакет to open a website in the Microsoft Edge
browser.

• Shared session to establish a connection with
a terminal server or open a Microsoft Excel
spreadsheet and close the shared session from
the child бот.

• IBM 5555 B01 and C01 models for TN5250
terminal types and the Default terminal for the
VT100 terminal type.

Enterprise A2019

Важное замечание:  This release includes a required update to your . Ensure that you complete the
update to continue with your automation activities when upgrading from a previous release to this release.

Автоматическое обновление Bot Agent | Обновление Bot Agent вручную

To verify which  version is compatible with this release, see Compatibility with release builds.
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Новые функции

Connect to EWS server with OAuth authentication
A new authentication is available for the Exchange Web Services (EWS) protocol with OAuth.
You can use the OAuth authentication and enable your EWS-managed API applications to access
Exchange online in Office 365.
Using Connect action for Эл. почта

Google Cloud Platform supported for On-Premises deployment
You can now host the Control Room, and create and deploy automation on devices configured to
use the Google Cloud Platform environment.

Операционная система, окружение и платформа, поддерживаемые для Control Room

LDAP channel binding for enhanced network security in On-Premises deployment
Control Room supports LDAP channel binding in order to comply with a security release from
Microsoft. LDAP channel binding provides enhanced security for network communications between
an Active Directory and its clients. It provides a more secure LDAP authentication over SSL and TLS.
Configure LDAP channel binding

Use Bot Agent with AWS WorkSpaces (Service Cloud case ID: 00652474, 00676112)
You can now deploy боты on Bot Agent devices that are configured on AWS WorkSpaces.

Совместимость Bot Agent

VT220 terminal type supported in Эмулятор терминала
To establish a connection and communicate with another machine, you can now use the VT220
terminal for sending and receiving text.
Using Connect action for Эмулятор терминала

Permission to cancel checkout in Control Room
Use the Cancel checkout permission to cancel checked-out TaskBots or files from the public or
private workspace.
• In the public workspace, the status of the бот changes to public.
• In the private workspace, the status of the бот changes to new if any changes were made to

the бот. Если изменений нет, то бот заменяется клоном.

Check out a single бот
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Новые функции

Enhancements to the Средство записи
• Record a task using the Universal Recorder or AISense Recorder from a single point of entry.

Both recorders are now managed through a single пакет, which enables faster and more
efficient updates.

• You can now record tasks in a Microsoft Edge browser that runs on Chromium (versions 79 and
later).

• Use the AISense Recorder Define option to capture an object that is only visible when you
hover the mouse over the object.

• Use the Resize window option in the Recorder > Capture action to set the window width
and height.
This option delivers a more reliable бот. It resizes the window to the dimensions at which the
task was recorded, thus increasing the likelihood that the бот identifies the target object.

Get started with recorders | Universal Recorder supported applications and browsers | Using the Capture
action

Use shared session in Эмулятор терминала
Use the new Shared session option to pass the exact state of an application to a concurrently
occurring TaskBot or MetaBot logic. For example, instead of connecting to the same application
multiple times for different tasks, you can use the option to connect to the application using a
single task, thus optimizing your automation logic in the long run.
Share session between TaskBot logic

Share an Excel session between боты
Use the Set session action from the Базовый Excel or Расширенный Excel пакет to assign an
Excel session to a variable, and then pass that variable from a parent to a child бот. This enables
the child бот to access the worksheet opened in the parent бот.

Базовый Excel пакет | Excel advanced workbook operations | Example of sharing an Excel session
between bots

New option for Выполнить задачу
In the TaskBot пакет, you can now use the Run action with an option to repeat the selected task
until you choose to stop it.

New search for roles in User Management API
Use the new Search for roles API in the User Management APIs in Swagger to obtain a list of
all the roles or details for a specific role.

Capture response status of REST API
In the Веб-служба REST пакет, you can capture the response status of the REST API in the
dictionary variable. The dictionary variable now shows the response key with its value.

New option for Веб-служба REST (Service Cloud case ID: 00489741, 00646436)
Use the Capture failure response action in the Веб-служба REST пакет to capture response
details in the response body.
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Новые функции

Use regular expressions in пакеты
You can use regular expressions (regex) in certain actions to support pattern-based search in a file,
folder, or Windows title. Regular expressions are supported in the actions of the Файл and Файл и
папка пакеты such as Copy, Delete, Rename, Print Multiple files, and Zip.
You can also use regular expressions in some пакеты that support the wildcard character in their
window titles.
The following пакеты and actions support regular expressions:
• Ожидать
• Распознавание изображений
• Имитация нажатия клавиш
• Мышь > Click action
• Legacy Automation > Manage windows control
• Распознавание текста (OCR)
• Экран
• Средство записи > Capture
• Run DLL > Run function (Legacy), Run function
• Окно: Activate, Close, Maximize, Minimize, Resize

Using Copy Desktop file action for file | Using the Capture action

Support for overloaded functions in DLL пакет
The DLL > Run function action can now handle .dll files that contain multiple functions of the
same name. The action calls the function based on the number of parameters passed.

Использование action «Выполнить функцию»

New actions for SAP captured objects
Use new actions that are available for Tree, Tab, and Label controls to perform operations for the
various objects captured from an SAP application.

Средство записи actions supported in various SAP versions
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Новые функции

Enhancements to elements in the form builder
• Image element: Upload image files to the form using this element.

Using the Image element
• Button element: Validate all the fields in a form using the Validate all form fields when this

button is clicked option.

Использование элемента «Кнопка»
• Password element: Use one of the following formatting options:

• Standard: set the character limit and choose additional security options.
• Custom: add a custom password on the Regular expression page.

Using the Password element
• Rich Text Editor element: Use this element in the Set action when creating a бот in order to

add or overwrite the value of a variable.
• Table element: Includes the following updates:

• New data types for Column settings:
• Date
• Число
• Выпадающее меню

• The following actions, which you can use during бот runtime:
• Set action to add rows to the table.
• Trigger events to add rows and delete rows.
• Sort table columns.

• Text Box element: Choose one of the following formatting options:
• Standard: set the character limit for this field.
• Custom: add a custom password on the Regular expression page.

Using the Text Box element
• Select file or Snapshot element: When you click Preview during бот runtime, the system

default application is used to display the selected file.
Using the Select File element | Using the Snapshot element

Enhancement to List view of боты
In the List view of the Bot editor, you now drag a selected action to the task logic.
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Новые функции

Import Enterprise 11 боты to Enterprise A2019 (Service Cloud case ID: 00512847)
• Bot Lifecycle Management Import feature: The Bot Lifecycle Management import feature

enables you to import Enterprise 11 боты from multiple Enterprise 11 Control Room instances to
a single Enterprise A2019 instance by using the aapkg file.
Bot Lifecycle Management | Импорт боты

• Bot Lifecycle Management Import API: You can also use this API to import Enterprise 11
боты to the Enterprise A2019 instance by uploading the aapkg file. However, you can import a
password-protected aapkg package only by using the Import API.
BLM API | see Import repository bots in BLM API

New endpoint in License API
Use the List details of Control Room licenses endpoint to retrieve metadata including the
license type, number of available licenses, number of licenses used in a specific Control Room
instance, and number of licenses used in all Control Room instances.
License API

Programmatically manage device login credentials
Use the Login setting endpoint of the Credential Vault API to set or update the device login
credentials to allow боты to run on the device.

Store multiple lines of text in a string variable
You can use a string variable containing multiple lines of text in the following actions:
• String > Assign
• String > Extract text
• String > Compare
• String > Lowercase
• String > Replace
• String > Reverse
• Log to file
• Message box
• The string condition in the If, Wait, and While actions

Arabic, Japanese, and Russian characters supported in variable names
You can now create variables with names containing Arabic or Russian characters, or Japanese
double-byte numbers.
Unicode range supported in variables
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Измененные функции

Configure granular security for Bot Agent (Service Cloud case ID: 00653807)
Starting from this release, only registered Bot Agent device IP addresses that are added in the
Allowed IP addresses list of the Network Settings can connect to the Control Room. In
previous releases, devices from all subnets and IP addresses within the corporate network were
allowed to connect to the Control Room URL.
Add access IP addresses

Update to Расширенный Excel пакет
The Open action in the Расширенный Excel пакет now opens a Microsoft Excel spreadsheet even
when a file extension is not provided.

Disable clone and view content permissions for check-in (Service Cloud case ID: 00656157)
When the Check in permission is selected, the Clone and View content permissions are also
automatically selected. As a Control Room administrator, you can now disable the Clone and View
content permissions when required.

Associate triggers with unattended Bot Runner
Ensure that the default device is not in locked state if you are associating triggers with unattended
Bot Runner.

Additional license support enhancements
Control Room administrators are enabled to install a new GUID license before an existing license
expires.

Change in edit device permission
Starting from this release, the permission to edit devices is not available in the system-created
AAE_Basic role by default in the Control Room. A user has to select the Edit the device(s)
permission separately.

Устройства

The following table lists the fixed features and the builds in which they were fixed (Сборка 7103 is the
latest build, and Build 7096 is the previous build). The fixes are cumulatively available in the latest build.

Исправленные функции

Build number ID обращения к облачному
сервису

Описание

7103 00684905, 00703481 A TaskBot now runs as scheduled
and no longer shows the device
status as Picked at runtime on the
View task in progress (Activity)
page when the TaskBot is running.

7103 00676476 An error is no longer encountered
when you run a child бот that
contains a Japanese full-width space
character in the name.
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Исправленные функции

Build number ID обращения к облачному
сервису

Описание

7103 00689935, 00689381,
00690368, 00690217,
0069053

License server syncing error
generated when control room
licenses and licenses stored on a
server are updated on different
schedules. This issue has been fixed.
Should an error message appear,
click "Sync licenses from Server" for
any new licenses in production to
manually sync the licenses.

7096 00667396, 00670001,
00653771, 00671553

Bot Scanner no longer encounters
an error when scanning боты with
non-ASCII characters in their name.

7096 00659334 The Offset from match option in
the Распознавание изображений
пакет now works correctly in
migrated боты.

7096 00669166 You can now migrate large боты (for
example, with 30+ dependencies
and 500+ lines) using the Бот
migration пакет. The system no
longer encounters an error when
migrating a бот that contains a
large number of nested IF/ELSE
commands.

7096 00659349 You can now migrate боты with
special characters in their names.

7096 00670985, 00674145 The system no longer encounters an
error due to Bot Store credentials
when you migrate from Version
11.3.3 or a later version to
Enterprise A2019.

7096 00679817 An unknown error is no longer
displayed when you are migrating a
бот that the Bot Scanner listed as
ready for migration.

7096 00457898, 00488494 You can now register a device with
a username that contains non-ASCII
characters such as Korean language
characters.

Прим.:  Before upgrading the
Bot Agent to the current version,
ensure that the registered device
is configured to use non-ASCII
characters.

Configuring post-installation settings
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Исправленные функции

Build number ID обращения к облачному
сервису

Описание

7096 00611887 You can now download an exported
бот package using the Internet
Explorer browser by opening the
download link received in the email.
You can also do this from the
Activity > Historical page.

7096 00647932 When you create a бот using
the Get method action in the
Веб-служба REST пакет, the UTF-8
character set is now supported.
Therefore, Korean characters are
processed correctly in the REST
API response. Previously, UTF-8
characters were not supported.

7096 00641126 You can now use the Get single
cell action in the Базовый Excel
пакет to extract the date correctly
for the Japanese date format.
Previously, the Japanese date was
displayed in double quotation marks.

7096 00634102 You can now use the Имитация
нажатия клавиш пакет with the
Alt+F4 key and set a longer delay
value between each keystroke.
Previously, the боты displayed an
error when a longer delay value was
set with the Alt+F4 key.

7096 00655739 In Веб-служба REST, the Rest API
Get call now works properly even
when the encoded URL string has
special characters such as double
quotation marks. Previously, the
Rest API Get call failed when the
URL string had double quotation
marks.

7096 00653944 The Строка пакет now shows the
correct output when you use the
loop action to read a file name
that does not have an extension.
Previously, when the file did not
have any extension, the filename
extracted using the loop displayed
an incorrect output.

7096 00677941 When an optional field (Mark field
required is not selected) is now left
blank, a form is validated without
any error messages during бот
runtime.
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Исправленные функции

Build number ID обращения к облачному
сервису

Описание

7096 00662011 When using the files and folders
trigger, you can now use any
available network drive to start a
бот.

7096 00666441, 00673888 For a folder trigger, you can now
select a folder name containing a
space character and the бот runs
successfully without encountering
any issues.
For example, you can select a folder
called 'Sales chart'.

7096 00622100 When Simulate keystrokes is
enabled for a hot key trigger, you
can now start a бот multiple times
using the associated hot keys
without encountering any issues.

7096 -- If an element is marked as Read-
only on the form builder screen,
a validation error is no longer
displayed for that field during бот
runtime.

7096 00570660 You can now use Windows forms
with the Run function action of the
DLL пакет.

7096 00624644 The system no longer encounters
an error when you upgrade from an
earlier version of Enterprise A2019
to a later version when the settings
are preserved and the installation
path is not the default location.

7096 00670008 You can now pause or resume a task
from the Activity > In progress
page.

7096 00667210, 00672875 In the Расширенный Excel пакет,
you can now use the Go to cell
action even if the Excel sheet
does not have any data or an
active cell is out of the worksheet
range. Previously, an issue was
encountered when you used the
Go to cell action and chose the
cell option as Active cell with the
Beginning of the row, End of the
row, Beginning of the column, or
End of the column option.
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Исправленные функции

Build number ID обращения к облачному
сервису

Описание

7096 00659098, 00669437 You can now edit the Start date of
an existing schedule to today's date,
provided the start time is set before
the бот is scheduled to run.

7096 00671392 You can now stop a бот that is in
progress using the Stop option from
the In progress (Activity) page
or the Stop option on the runtime
window that appears when the бот
is being executed.

7096 00647761 You can now define a list variable of
subdata type Boolean or datetime
within an action. Previously, the
бот encountered an error in this
scenario.

7096 00671478 Fixed an issue in the Task Bot >
Run action where the value of an
input variable disappeared when the
user clicked Save. This issue only
occurred when the Current Task
Bot option was selected.

7096 00663719, 00635437 Fixed an issue where the
Распознавание текста (OCR) пакет
was missing from Control Room
instances hosted on Microsoft Azure.
The connection with the Microsoft
Azure database timed out before the
Распознавание текста (OCR) пакет
.jar file could complete the upload.

7096 00631133, 00636174 In the Ожидать пакет, the Wait
for condition action in the recorder
object no longer waits indefinitely
during бот execution. If the required
window or its control does not
exist, the бот waits for the required
window or its control for the time
specified in the Wait for control
field. If the required window or
its control is not found within this
specified time, the бот continues to
perform the next set of actions.

© 2023 Automation Anywhere. All rights reserved.     503



    Automation Anywhere - Learn

Исправленные функции

Build number ID обращения к облачному
сервису

Описание

7096 00628863 Бот files or dependencies are no
longer lost when you check in or
check out a бот from the private
or public workspace when the
Elasticsearch service is running
and not in index read-only mode.
Previously, an error occurred when
a бот was either checked in or
checked out, and the бот files or
dependencies were lost and could
not be recovered.

7096 00673520 When a бот is deployed through
RDP with a predefined screen
resolution, the RDP resolution
settings are now applied correctly
during бот execution. Previously,
the бот was executed with an
interchanged resolution (the height
and width pixels were interchanged).

7096 00670346 After you edit a бот schedule, the
input value of a variable in the бот
no longer has to be reinitialized and
the бот does not show the default
output value for the variable when it
is executed.

7096 00653056,
00651853, 00647949,
00657465,00670024

The In progress activity is now
displayed correctly for боты
deployed on Bot Runner by any user.

7096 -- When developing custom packages,
you can now set your name in the
vendor column. To set the name,
update the author property of
the build.gradle file, as shown
below:

packageJson{
artifactName =
 project.name
group = "$groupName"
author = "<entername>"
 }

Leaving the field empty shows the
vendor name as unspecified.

7096 -- Multiple users can now
simultaneously run a бот associated
with a form without encountering
any issues on the same Bot Runner
machine.
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Исправленные функции

Build number ID обращения к облачному
сервису

Описание

7096 -- You can now migrate Enterprise
11 боты that contain variables
that are in a different letter case
(uppercase or lowercase) than those
in Enterprise A2019. Variables are
case-sensitive in Enterprise A2019
but not in Enterprise 11, which
previously resulted in an error.

7096 00592758 You can now create a variable with
a name that starts with a numerical
character.

7096 00670994 You can now register with the
Control Room from a multiple-
user device configured for Active
Directory users.

7096 00677479 The deployment time of a priority
queue no longer takes a long time
(for example, more than 1 hour)
to process Work Items required for
workload automation.

7096 00667110 You no longer have to restart the
Automation Anywhere Bot Agent
service to resume queued Work
Items that are stuck in in-progress
state.

7096 00673043 When you specify a value in the
numOfRunAsUsersToUse parameter
of the Bot Deploy API, the
weighted system algorithm now
assigns tasks to the Bot Runner with
the least number of tasks queued
and currently running. Previously,
the algorithm did not correctly
calculate the weight of queued and
running tasks, which resulted in
an inefficient task allocation to the
same one or two Bot Runner.

Известные ограничения

When a бот opens a website inside a loop, the Средство записи Capture action fails after the
execution of Launch Website.
Обходное решение. Add a delay of a few seconds in the loop between the Launch Website and
Средство записи Capture action.

The Средство записи Capture action does not support object recapture for the AISense
technology type.
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Известные ограничения

The system does not display a value for a session variable when the variable is selected as
Watched variables in Debug mode.

The session variable returns a blank value when it is used as output in a бот and the бот is
deployed using the Bot Deploy API.

After an upgrade to the latest version of Enterprise A2019, the бот might encounter an error if you
are using the Close action of the Window пакет version 2.1.0-20200813-181240 or earlier.
Обходное решение. Add a delay of 50 milliseconds after the Close action in the бот.

The Средство записи пакет takes a long time (for example, approximately 6 hours) to upload to a
remote application repository path of an On-Premises Control Room deployed on Microsoft Azure.
Обходное решение.
1. Before you install or upgrade to this version, configure the repository path in a local directory

of the Control Room node to upload the пакет.
2. After installing or upgrading, verify that all пакеты are available in the Packages page of the

Control Room.
3. Change the repository path to a remote file share.

The AISense Recorder fails if you manually upgrade the Средство записи пакет version, such as by
importing a бот that contains a Средство записи пакет version from a more recent build than the
destination Control Room. Always upgrade the Средство записи пакет through the Control Room.

Automation Anywhere Robotic Interface (AARI)

Новые функции

Run a process in private workspace
You can now run a process in your private workspace by using the Run option in the process editor.
The боты in the process are then executed on the default device of the Bot Creator.

Настройка процессов

Use the Data Privacy tag field
The Data Privacy tag enables users to generate hidden custom output in their process tasks
(Start panel, Human Task, and Bot Task). Users can enter the variables for this field during
runtime with values. In the web portal, the AARI admin can use this tag to check for requests or
tasks by using personal user data. The admin can also filter using this field.

Создание процесса AARI | Filter and search for a request | Фильтрация и поиск задач

Use variables types
You can now use new variables in the process editor such as createdOn and updatedOn
(DateTime), id (Number), and title (String). These variables are part of a data flow (workflow
engine) that moves data between each step of a process and requires variable input for the process
to run properly.
AARI variable types
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Новые функции

View previous selected tasks
AARI users can now reference selected actions of their tasks. When they view a submitted task in
request view, a check mark indicator is now displayed next to the buttons that are selected.

Измененные функции

Configure scheduler user to allocate device pool to AARI on the web interface
In the AARI Settings page, the AARI administrator can now configure a scheduler user to allocate
the Control Room resources (devices and unattended Bot Runner) to AARI on the web interface.
The scheduler user must have View my bots and Run my bots permissions and have access
to a device pool and Bot Runner. The AARI process can then use those resources for each бот
deployment.
Configure scheduler user for AARI on the web

End point display
In the Completed panel, the End point has a new display option Update request title that
enables the user to update the request title. When the user updates the Display message field,
the update is now reflected in request view.

Создание процесса AARI

Use F2 to insert variables
You can now use the F2 keyboard shortcut to insert variables in the process editor.

Исправленные функции

ID обращения к облачному сервису Описание

-- The Task display name option in the Start
panel is now set to Request Creation by
default. Any name changes by the user is now
reflected in the request view.

-- The Feed data into form table in the process
editor now works properly and users can now
edit the field.

-- In a form that contains a Number field set to a
10-character limit, when you enter the maximum
character limit (for example, 1234567890) in the
number field in request view, the number values
are now accepted.

-- When you create a process with a form that
contains a Date element, the Condition option
in the If/Else pair action now allows you to
enter a variable. Previously, the option did not
allow you to enter a variable.
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Известные ограничения

In the process editor, if a бот contains an incorrect input variable, the properties panel highlights
the wrong element: Browse in the Select Task Bot field is highlighted instead of the incorrect
variable.
Обходное решение. Hover your mouse over the red icon next to the Bot Task in the process
editor to see the error.

In the process editor, if you replace the Go to option with an End Process, the End Process icon
does not display the status (Completed, Failed, Canceled) correctly.
Обходное решение. Click the End Process icon and change the status.

A Bot Task cannot pass data to the next task (Human Task or Bot Task) if it contains Japanese
characters in its output variable name.
Обходное решение. Use English characters for the variable name in the Bot Task.

If a scheduler user has multiple sets of configurations (device pools and Bot Runner), due to a
mismatch in the selection of the device pool and the Bot Runner, the бот deployment fails.
Обходное решение. Set Bot Runner in the Run As section of the consumer role. Ensure the
scheduler user has access to only one device pool and one consumer role that has run-as users.

When you access AARI through the web interface, the Request ID and Task ID consider the data
as string type instead of numeric data type and sorts it accordingly.
For example, if a Request ID or Task ID starts from 1 through 30, the IDs are sorted as string
data type (1, 10, 11, 12, 13, …, 2, 22, 23, …, 30) instead of numeric data type (1, 2, 3, 4, …, 30).

In some бот development failure scenarios, for example, files are not found or the scheduler user
does not have access to the бот file, бот development fails by timing out after one hour instead of
displaying an error.

If an AARI manager creates a team with the same name as a team created by any other manager,
no error message is displayed and two teams are created with the same name.

When you access AARI through the web interface, the task and case list pages do not display the
following words in the localized languages:
• Поиск по тегам
• Результаты
• Запросить заголовок

In the process editor page, the following words are not displayed in the localized languages:
• Запись процесса
• Запустить
• Отменить
• Вернуть
• Тег конфиденциальности данных
• Auto assign this task to
• InitialData
• Обновить заголовок запроса (необязательно)
• Обновить имя задания (необязательно)
• Boolean condition
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Discovery Bot

Новые функции

Column headers updated in Recordings page
The Recordings page now displays labeled column headers when you review captured steps for
recordings. The following headers are displayed for the associated text field:
• Скриншот
• Приложение
• Данные
• Описание шага

Запись бизнес-процесса Discovery Bot

Highlight where you click or enter data when recording processes
The system now displays the area, component, or control where you click or enter data with a red
highlighted box at the time of recording.

Прим.:  The red highlight is only shown in the captured screenshot in the generated бот. The
highlight is not shown on captured screenshots from the Recordings page for review and
after submission to the analyst. The highlight is also not shown from the preview pane from the
Aggregated and Opportunity tabs for the analyst review.

Supported applications and browsers for Discovery Bot

Condition and value displayed for each branch in Aggregated view
For the System generated view, the condition and its value for each branch are automatically
retrieved and displayed as part of the auto-generated Aggregated view.

System-generated aggregation
You can now merge multiple recordings into a single aggregated view automatically by selecting the
required set of recordings.
Create a process view with branches and opportunities

Convert system-generated aggregated view to a manual view
You can now convert a system-generated aggregated view to a manual view using the Save as
[manual] option or the Convert to Manual option from the Views table. This option enables
you to add more recordings or steps from other recordings to your process view.
Create a process view with branches and opportunities

Create an opportunity, including all steps and branches
You can now use the Select all steps option to create an opportunity that includes all steps,
branches, and sub-branches.
Create a process view with branches and opportunities
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Новые функции

Download a process definition document (PDD) (previously, Export to Word)
The Export to Word option is now renamed as Download Process Definition Document
(PDD). Когда создается возможность, PDD автоматически начинает обработку в фоновом
режиме. When the PDD is ready for download from the Control Room, an email notification is sent
to the email address on file to the opportunity owner.

Прим.:  You must be the owner of the opportunity to be able to download the PDD.

Review opportunities and convert to

Receive email notification when your бот is converted successfully
You can now receive an email notification when your бот is successfully converted. Click the
hyperlink in the email to take you to your folder in which the бот was generated.
Review opportunities and convert to

Измененные функции

Zoomed-in view of captured steps is increased
The zoomed-in view in the Screenshot field is now increased from x4 to x8 for better readability of
captured steps.

Permissions layout
The layout of the permissions for Discovery Bot is now changed to separate the individual and “all”
permissions to easily manage access control.

Исправленные функции

ID обращения к облачному сервису Описание

-- When you create a branch in a view, typically
a single step from the current branch is moved
into the left branch while a new branch with an
empty box is added to the right branch. You can
add steps from a different recording only into
the empty box in the right branch. Typically, only
one step from the original branch is included in
the left branch. If the branch is created following
the last step in the flow, then no steps will be
included in the left branch. You can now add
new steps to the left branch in case it was the
last step. You can also move the endpoint of
the newly created branch lower or higher in the
process to include additional steps in the left
branch.

Известные ограничения

In the Opportunities tab, the process and owner column does not allow you to sort in ascending
or descending order, or when you sort for both process and owner.
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Известные ограничения

In the Opportunities tab, the search field and the filter drop-down option do not work when you
search for the Process or Owner columns.

The Download PDD option is disabled if you are not the owner of the opportunity.

The Delete icon is not properly visible in the edit recordings screen in Internet Explorer.
Two-finger swipe on the track pad does not change the zoom level in any canvas of the
Aggregated and Comparison tabs.

Discovery Bot is currently not supported on Linux.

The red highlight is only shown in the captured screenshot in the generated bot. The red highlight
is not shown on captured screenshots from the Recordings page for review and after submission
to the analyst. The highlight is also not shown from the preview pane from the Aggregated and
Opportunity tabs for analyst review.

IQ Bot

Новые функции

Support for Arabic language
When creating a learning instance, you can now choose the Arabic language from the Primary
language of documents drop-down menu, with the following limitations:
• Advance table extraction is not available.
• Search field on the Валидатор is not supported.
• Arabic numerals are not supported.

For example, if the document has date or time in Arabic language, it is extracted as text and
validations can fail.

Прим.:  You can still use string-based validation checks (such as regular expressions) for Arabic
numerals.

• Arabic is only supported on ABBYY FineReader Engine 12.4.

Creating a learning instance

Default validations for a group
When editing a learning instance, you can now use the Select the default validations group
drop-down menu to select an available group. This allows all the new group documents in
production to be extracted based on the custom logic and validations defined in this selected group,
before it goes to the Валидатор.
Edit a learning instance
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Измененные функции

Automatically detect check box
IQ Bot can now automatically detect check boxes and radio buttons in a document. You can enable
this feature when creating a learning instance.
Creating a learning instance

• With this feature enabled, during training, if you select check box from the data type drop-
down list and then you select the field value, only the check box segments are displayed.

• This feature does not work with the PDFBox option enabled.
Disable PDFBox option

Tegaki API OCR improvements
IQ Bot now uses enhanced Tegaki API OCR segmentation to improve accuracy in the following
scenarios:
• Multiple fields are merged into a single SIR
• Segmentation on empty spaces
• Overlapping SIRs
• Incorrectly located SIRs
• Partial or incorrectly captured values from SIRs

IQ Bot Tegaki API OCR engine

Updated versions of RabbitMQ v3.8.18 and Erlang/OTP
The IQ Bot installation package now includes RabbitMQ v3.8.18 version 3.8.8 and Erlang/OTP
version 23.0.4.
RabbitMQ and Erlang/OTP upgrade

PyArabic removed from Python installation
PyArabic is one of the Python libraries that was used in content extraction for Arabic language (right
to left). Because Arabic language is now supported by default with IQ Bot installation, PyArabic is
removed from Python installation.
List of Pandas Libraries which are supported and not supported on Automation 360 IQ Bot (A-People login
required)

Прим.:  Ensure you update any бот that you have deployed using PyArabic.

Performance improvement (Service Cloud case ID: 00629302)
IQ Bot now takes significantly less time to create a бот for groups containing only production
documents.
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Исправленные функции

ID обращения к облачному сервису Описание

00500914 The TesseractLog.log file is now available in the
following directory: C:\Users\Public\Public
 Documents\Automation Anywhere IQBot
 Platform\Logs\Engine\.
The log level is set to error by default.
You can change this setting in the
CognitiveServiceConfiguration.json file.

00430923, 00618234, 00636422,
00478986, 00414921

All uploaded documents are now rendered correctly,
irrespective of their content orientation while uploading,
which enables you to train them without encountering
any issues. Previously, when you created a learning
instance, documents that did not have the correct content
orientation (they were upside down or tilted) could not be
trained.

00653929 IQ Bot On-Premises: With segmentation improvements,
you can now train documents in the Korean language
using the Tegaki API OCR engine without any system-
identified region (SIR) errors.

-- The system no longer creates any unnecessary folders for
successfully classified documents that are uploaded using
the IQ Bot [Local Device] пакет.

-- You can now use the designer page when creating a
learning instance to test all the documents, without any
error messages.

00590165 For a learning instance, you can now use the See
extraction results option to browse all the documents in
the selected group.

00672470 After validating the fields of production documents, you
can now use the Save current document option to save
all the validated document, without any error messages.

-- Check box fields are now extracted with better accuracy.
You can use the Checkbox auto-detection feature so
that IQ Bot automatically detects the check box fields and
radio buttons.

00652269, 00619139 When you now run a бот and try to edit it while it is
still running, the following correct message is displayed:
Staging Documents for this Vision bot is
in progress. Please try after some time.
Previously, the following incorrect message was displayed:
Learning instance not found.

00601401 When creating a learning instance, you can now use
the Thai language for form and field names without
encountering any issues.

00624416 When you migrate a learning instance, group descriptions
are now migrated without any errors.
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Исправленные функции

ID обращения к облачному сервису Описание

-- If you select any field on the Валидатор screen, the focus
from that field is no longer lost when you now click or
draw to select SIR.

00662968 Sometimes, when you click See Extraction Results
and the preview fails, IQ Bot now correctly displays
the following error message after a timeout of 2
minutes: Error occurred while extracting the
document. Please re-check the training/
document. Previously, when the preview failed, the page
kept loading indefinitely.

00674110 Production documents are now moved to the Валидатор
without any errors, irrespective of how the бот was trained
(number pages, number of segments in each page, or
number of tables and fields extracted).

Известные ограничения

IQ Bot On-Premises and Cloud
In the table area of the Валидатор, if you add a new row, enter a value, and then delete this row,
the value of the next row is replaced by the content you entered in the deleted row.

IQ Bot On-Premises and Cloud
In the Валидатор, when you click any validated field and then click any other cell, the value in the
validated field is deleted.

IQ Bot On-Premises and Cloud
When you upload a document to production immediately after deleting a бот it was associated
with, extraction results are not displayed.
Обходное решение. Use one of the following options:
• Select the Disable cache option in the Network tab.
• Ensure you wait at least 3 minutes between deleting the бот and uploading the document.
• Empty the cache and reload the page.

IQ Bot On-Premises and Cloud
You cannot use Express mode to install IQ Bot.

IQ Bot On-Premises and Cloud
Numerals in the Polish language are not accepted or validated in the Валидатор.

IQ Bot On-Premises and Cloud
If you create a user role with 2-byte non-English characters, services fail with an invalid
characters message.

IQ Bot On-Premises and Cloud
If the name of a learning instance has both English and Arabic characters, the time stamp of the
backup file is appended in between the filename.
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Известные ограничения

IQ Bot On-Premises and Cloud
You cannot use the draw functionality to generate an SIR when you zoom in on a document in the
Валидатор.

IQ Bot On-Premises
After installing IQ Bot, MLWeb services stops responding.
Обходное решение. Manually stop and restart the MLWeb services.

IQ Bot On-Premises
If you add a new language after upgrading to IQ Bot A2019, the Learning Instance page is not
displayed due to Language API cache issues.
Обходное решение. Clear the cache and restart the IQ Bot service.

IQ Bot On-Premises and Cloud
Если вы попытаетесь обработать документ PDF с помощью pdfboxOCR, то SIR будут
неправильно размещены на флажках.
Обходное решение. Disable the pdfbox OCR when you create a learning instance.

IQ Bot On-Premises and Cloud
If you create a learning instance with Auto Checkbox Detection enabled, check box SIRs cannot
be selected.
Обходное решение. Нарисуйте поверх SIR флажка вместо того, чтобы выбирать
идентифицированное поле SIR.

IQ Bot On-Premises and Cloud
Starting with IQ Bot A2019.17, the default Распознавание текста (OCR) engine is changed to
ABBYY FineReader Engine 12.4 from the previous 12.2 version. Therefore, if you have migrated
learning instances from earlier versions, you might have to retrain your боты because there could
be a change in segmentation.

IQ Bot On-Premises and Cloud
The Default validations group is not overwritten on the imported learning instance even when
the Overwrite option is used when you import that learning instance.
Обходное решение. Edit the learning instance after importing the IQBA file and change the
default group.

IQ Bot On-Premises and Cloud
A learning instance is exported as an IQBA file that contains Projectdetails.csv. When you
extract this .csv file, the column header name for the Default validations group in the table is
not available. However, the corresponding value in that column is available.

IQ Bot On-Premises and Cloud
If you re-import an IQBA file for a deleted learning instance, the Default validations group
setting available in that IQBA file is not applied to the learning instance.
Обходное решение. Edit the learning instance after importing the IQBA file and change the
default group.
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Bot Insight

Новые функции

New AARI dashboard in Bot Insight
Use the AARI dashboard to view various widgets that provide information about requests created
from published processes in AARI. The dashboard also provides statistics on the status of created
requests.
AARI dashboard

Исправления в системе безопасности

ID обращения к облачному сервису Описание

-- The Allow Header HTTP header is removed
from Bot Insight.

Поддерживаемые пакеты

Пакет Версия

Приложение 2.1.0-20200921-085720

Интеграция приложений 1.1.0-20201014-042506

Анализ 2.2.4-20200903-113949

Active Directory 2.1.0-20200921-085716

Логический 2.1.0-20201014-042509

Перенос ботов 2.5.0-20200902-045043

Браузер 2.1.0-20201002-123733

Буфер обмена 2.1.0-20201014-042520

Комментарий 2.2.0-20201014-042520

CSV/TXT 2.3.0-20201014-082525

База данных 2.2.0-20201013-052941

Таблица данных 2.3.0-20201030-143334

Дата/время 2.2.0-20201014-042531

Задержка 2.2.0-20201014-042532

Словарь 3.2.0-20201014-042532

Run DLL 3.2.0-20201105-205159

Эл. почта 3.1.0-20201104-062204

Обработчик ошибок 2.2.0-20201014-042541

Базовый Excel 2.3.0-20201027-160012
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Пакет Версия

Расширенный Excel 5.1.0-20201027-155758

Файл 3.1.0-20201016-065515

File & folders 1.1.0-20201023-202725

Папка 3.0.0-20201016-065517

FTP / SFTP 2.1.0-20200921-085757

IF/ELSE 2.1.0-20200921-085758

Распознавание изображений 2.1.0-20201014-042552

Интерактивные формы 2.17.3-20201102-103733

IQ Bot 2.1.0-20201013-095304

JavaScript 2.3.0-20201104-062431

Имитация нажатия клавиш 2.4.0-20201021-163833

Legacy Automation 3.2.0-20201104-062439
1.3.0-20201105-151906

Список 2.2.0-20201014-042806

Записать в файл 2.2.0-20201014-042806

Цикл 2.1.0-20201014-042808

Message Box 2.1.0-20201014-042808

Миграция 2.7.0-20201106-072418

Мышь 2.1.0-20201014-042814

Число 2.1.0-20201014-042823

Распознавание текста (OCR) 2.2.0-20201104-062503

Office 365 Excel 2.2.0-20201104-062559

Календарь Office 365 2.1.0-20200921-085726

Office 365 OneDrive 2.1.0-20201014-042924

PDF 2.5.0-20201014-042929

PGP 2.2.0-20201014-042931

Ping 2.1.0-20201014-042932

Принтер 2.1.0-20200921-090131

Воспроизвести звук 2.1.0-20200921-090123

Запрос 2.1.0-20200918-081201

Python Script 2.3.0-20201105-204912

Средство записи 2.0.9-20201105-164103

Веб-служба REST 3.1.0-20200928-231420

SAP 2.2.0-20200921-090209
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Пакет Версия

Экран 2.1.0-20201014-043037

SNMP 2.1.0-20201014-043041

Служба 3.0.0-20200921-090214

Веб-служба SOAP 3.1.0-20200921-090219

Строка 3.1.0-20201014-043052

Система 3.0.0-20200921-090225

Задача 2.0.1-20201023-202703

Эмулятор терминала 3.4.0-20201028-021451

Trigger Email 1.1.0-20201105-152220

VBScript 2.3.0-20201105-205228

Ожидать 3.1.0-20201014-043117

Окно 2.2.0-20201022-121649

Рабочая нагрузка 2.3.0-20201105-205233

XML 2.1.0-20201014-043121

Ссылки, связанные с данной
Заметки о выпуске Community Edition A2019.17

Enterprise A2019.16 Release Notes
Дата выпуска: 28 September 2020

Review the new features, supported packages, changed features, fixed features, security fixes, and known
limitations in the Enterprise A2019.16 (Сборка 6463) release. IQ Bot is on Build 6443.

Важное замечание:  We have updated Enterprise A2019.16 to Сборка 6463 to include fixes for
issues with checking in and checking out боты (Service Cloud case ID 00666880, 00670899, 00672441,
00670455, 00672346), and Universal Recorder (Service Cloud case ID 00664020). See the Fixed features
section for more information.

• Enterprise A2019
• Discovery Bot
• IQ Bot
• Bot Insight
• Automation Anywhere Robotic Interface (AARI)

Enterprise A2019

Прим.:  Starting with this release, if you are installing the Control Room in Linux environment, ensure that
Python 3.6 is installed.
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Важное замечание:  This release includes a required update to your . Ensure that you complete the
update to continue with your automation activities when upgrading from a previous release to this release.

Автоматическое обновление Bot Agent | Обновление Bot Agent вручную

To verify which  version is compatible with this release, see Compatibility with release builds.

Новые функции

Migration to Enterprise A2019 (currently available only to customers in the Migration
Early Adopter Program)
Enterprise A2019
Migration to Enterprise A2019 is currently only available to select customers through our Migration
Early Adopter Program. If you are interested in learning more about this program or a timeline
for when migration will be available to all customers, contact your Automation Anywhere
representative.
• Enterprise 11 only

• Migrate audit logs to Enterprise A2019.

Миграция журналов аудита Enterprise 11
• Migrate боты that contain disabled commands that have validation errors.
• Migrate боты that contain Delete, Delete All Messages, and Get All Messages

commands to automate an email-related task on Exchange Web Services (EWS).

• Enterprise 10 only
Migrate user credentials to the Enterprise A2019 Credential Vault.

Процедура копирования данных Enterprise 10 в Automation 360
• Enterprise 11 и Enterprise 10

• Migrate боты that contain the Variable Operation command, which re-initializes the row
and column index of an array variable using a variable.

• Migrate боты that run MetaBot Logic and return the values to a dictionary variable.
• Migrate MetaBots that contain DLLs that use lists, values, arrays, and two-dimensional arrays

as input and output.

Как выполняется миграция MetaBots
• Migrate боты that contain Send Email with Attach Variable option from the Обработка

ошибок command to the Enterprise A2019 Обработчик ошибок package.

Сопоставление пакетов для миграции
• Migrate боты that contain the Image and Coordinates play modes from the Object Cloning

command to the Средство записи пакет in Enterprise A2019.

Сопоставление пакетов для миграции
• Migrate боты that contain credential variables in select commands such as Active Directory,

Excel, Веб-служба REST, and Эмулятор терминала to Enterprise A2019.
For the complete list of commands, see Сопоставление переменных для миграции.
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Новые функции

Support for using CSV and TXT files as databases
Enterprise A2019 and Community Edition
Use the actions from the База данных пакет to connect with and perform create, read, and update
operations on the file.

Использование action «Подключить» для базы данных | База данных пакет

Universal Recorder support for standard Microsoft controls in Microsoft Silverlight
Enterprise A2019 and Community Edition
The Universal Recorder can now capture calendars, buttons, check boxes, combo boxes, date
pickers, labels, links, list views, radio buttons, sliders, tabs, tables, text boxes, and trees from
applications running Microsoft Silverlight version 5.

Use variable to specify a child бот to run
Enterprise A2019
Use the Control Room path in the Run action of the TaskBot пакет to use a string variable to
specify the child бот you want to run.
TaskBot пакет

Install Bot Agent in bulk using registration key (Service Cloud case ID: 00616591)
Enterprise A2019
As an Control Room administrator, you can generate a registration key from the Control Room
settings to install Bot Agent in bulk on multiple devices. You can use the registration key in an
installation script or as part of the Active Directory group policy for configuring the Control Room
users.
Generate registration key to install Bot Agent in bulk

Automatically detect proxy settings for Bot Agent installation to support NTLM
authentication (Service Cloud case ID: 00446932, 00639773)
Enterprise A2019 and Community Edition
The proxy settings for a Bot Agent are automatically detected if the Automatically detect
settings option is selected in the LAN settings for a System user and Current user on the
machine where the Bot Agent is installed. This allows Control Room users to be authenticated using
NTLM.

Restrict network access to Cloud Control Room URL
Enterprise A2019
System administrators can restrict access to the Cloud Control Room URL from only those IP
addresses within the corporate network for more granular security. The Automation Anywhere
Control Room provides the ability to specify a list of IP addresses or IP subnets that are allowed for
Cloud Control Room URL and API access. Enterprise A2019 users with Control Room administrator
privileges, such as to access Administration > Settings, can view, add, or edit this list.
Add access IP addresses
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Новые функции

Add Elasticsearch credentials for enhanced monitoring and alerting
Enterprise A2019
An option to provide Elasticsearch credentials is now available in the installer because the updated
Elasticsearch version 7.8 configured for Control Room uses Open Distro version 1.9.0. This feature
enables the server to deploy an enhanced monitoring and alerting system.
Add Elasticsearch credentials

Support for Chinese, Japanese, and Korean characters in variable names
Enterprise A2019 and Community Edition
You can now create variables with names containing Chinese, Japanese, or Korean characters. You
can also migrate боты that contain variables named using these characters.
Unicode range supported in variables

Support for Chinese language for Эмулятор терминала (Service Cloud case ID: 00500324)
Enterprise A2019
You can now use the simplified and traditional Chinese language with 5250E terminal DBCS models
such as IBM 5555-C01 and IBM 5555-B01.

New Services пакет available
Enterprise A2019 and Community Edition
Use the new Services пакет to automate operations and application services. You can start, stop,
pause, resume, or to get the status of a Windows or application service.
Service пакет

Enhancements to the Расширенный Excel пакет
Enterprise A2019 and Community Edition
In the Расширенный Excel пакет, you can now use Read value from a cell. You can choose the
Read option to read either visible text or the value from the cell. The default option is set to Read
visible text in cell.
For example, if the cell has $50 as the value, then the Read cell value option reads the value
as 50, ignoring the currency format. The Read visible text option reads the content along with
currency format as $50.
This option is available for the following actions:
• Получить одну ячейку
• Получить несколько ячеек
• Прочитать строку
• Прочитать столбец
• Get worksheet as datatable
• Цикл

Cell operations in Расширенный Excel | Row and column operations in Расширенный Excel | Цикл
пакет
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Новые функции

Automate a task on a range of cells in an Excel worksheet (Service Cloud case ID:
00651299)
Enterprise A2019 and Community Edition
In the Расширенный Excel пакет, you can perform operations on the range of cells for Go to cell
and Set Cell actions.
Cell operations in Расширенный Excel

New condition in the Если and Цикл пакеты
Enterprise A2019 and Community Edition
Use the Service is running or Service is not running condition to execute actions based on
whether a particular service is running or not. For example, when you send a mail using this
condition, the бот can verify if the SMTP service is running or not.

Если пакет | Цикл пакет

Capture hidden objects using AISense Recorder
Enterprise A2019
Use AISense Recorder to capture hidden image buttons on the application screen.
Edit a task recorded using AISense

New operations on SAP captured objects
Enterprise A2019
Use new options that are available to perform operations such as Set Focus and Select item by
key for the various objects captured form an SAP application.

Pass parameters of various types to a DLL function
Enterprise A2019
Use the new Run function action to pass parameters of various types to a DLL function. The Run
function that was available in earlier versions is now renamed to Run function (Legacy) and
enables you to pass only dictionary variable as parameter to a DLL function.

Использование action «Выполнить функцию» | Using the Run function (Legacy) action

Form builder updates
Enterprise A2019
The form builder now includes the following new elements:
• Rich text editor- Enables you to add a customizable element to the form.
• Table- Enables you to add tables to a form.

Create a form

Enhancements to the form preview
Enterprise A2019
When you click the Preview option in the form builder screen, you can drag the form. The
corresponding X and Y coordinates are updated automatically.
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Новые функции

Enhancement to the Snapshot element
Enterprise A2019
You can now create a folder if the filepath is not available or change the destination folder of the
snapshot file during бот runtime.
Using the Snapshot element

Update to the Interactive forms пакет
Enterprise A2019
Use the Validate form action to validate all the elements of a selected form.
Interactive forms пакет

New permission to view basic information about users and roles (Service Cloud case ID:
00491694)
Enterprise A2019
The View Users and Roles basic information permission enables you to view the names of
users and roles when you are performing various tasks in the Control Room. For example, a user
must have this permission to view the roles that can be assigned to a user when creating or editing
that user. After you upgrade from an earlier version to this release, this permission is granted to all
existing roles.

Securely pass values in header and parameters of calls to a REST or SOAP web service
Enterprise A2019 and Community Edition
Credential variables enable users to retrieve sensitive values from the Credential Vault and pass
them to the web service. Use credential variables in the header or parameter fields of actions from
the Веб-служба REST or Веб-служба SOAP пакет.
Credentials and credential variables in the Bot editor | Веб-служба REST пакет | Веб-служба SOAP
пакет

Return system parameters of the device on which a бот is running
Enterprise A2019 and Community Edition
Use the Get environment variable action from the Система пакет to return the system
parameters, including HomePath, ProgramData, ProgramFiles, SystemRoot, and UserDomain.
Get environment variable action

Remove Git integration configuration (Service Cloud case ID: 00633948)
Enterprise A2019
You can now remove or disable a Git integration configuration from your Control Room when the
бот information stored in your Control Room does not have to be synchronized with the remote Git
host.
Remove Git integration configuration

Expanded data type support in DLL пакет
Enterprise A2019 and Community Edition
The DLL пакет now accepts table variables as input parameters or to hold action output.
Using the Run function (Legacy) action
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Новые функции

Create variable within Dictionary > Assign and List > Assign actions
Enterprise A2019 and Community Edition
The Assign action from the Словарь and Список пакеты now offers users the option to create a
new variable within the Select source variable field. Previously, users could only select a variable
from a list of existing variables.

New API for license management
Enterprise A2019
The License API contains endpoints to retrieve Control Room license details (such as the expiration
date and license mode) and to update the Control Room after license reallocation or renewals.
License API

New expression in the Legacy Automation пакет
Enterprise A2019
The List to table expression supports migrated боты containing a variable that has to be
converted from a list type to a table type.
Legacy Automation пакет

Multi-user device sessions on terminal servers
Enterprise A2019
Multi-user device sessions are now supported on terminal servers. Вы можете выполнить
указанные ниже действия.
• Set screen resolution at either the device or Control Room level.
• Set a multi-user device as the default device for Bot Creator users and attended and unattended

Bot Runner users.
• As a licensed user (with a default device), set another device as your default device using the

Make default device option from the device menu.
• View and edit the device settings on the device landing page.

The device landing page shows additional information about the user-provided device name
(device nickname), device type, and the default user.

• Convert an existing device to a multi-user device in order to share the same device between
Bot Runner and Bot Creator users who can then coexist in different sessions simultaneously. (ID
обращения к облачному сервису: 00624046)

About multi-user devices | Convert an existing device to a multi-user device | Configure RDP-based
deployment for multi-user devices

Поддерживаемые пакеты

Пакет Версия

Node Manager 14.1.7079

Приложение 2.1.0-20200819-064505

Интеграция приложений 1.1.0-20200825-070948

Анализ 2.2.4-20200903-113949

© 2023 Automation Anywhere. All rights reserved.     524

license-api.html


    Automation Anywhere - Learn

Поддерживаемые пакеты

Пакет Версия

Active Directory 2.1.0-20200825-070945

Логический 2.1.0-20200831-031000

Перенос ботов 2.5.0-20200902-045043

Браузер 2.1.0-20200825-071008

Буфер обмена 2.1.0-20200831-031014

Комментарий 2.1.0-20200831-031015

CSV/TXT 2.3.0-20200825-071131

База данных 2.1.0-20200913-060112

Таблица данных 2.1.0-20200831-031946

Дата/время 2.2.0-20200831-031025

Задержка 2.2.0-20200831-031026

Словарь 3.2.0-20200831-031027

Run DLL 3.0.0-20200831-110441

Эл. почта 3.0.0-20200901-105426

Обработчик ошибок 2.1.0-20200831-031055

Базовый Excel 2.1.0-20200831-031843

Расширенный Excel 5.0.0-20200909-124042

Файл 2.2.0-20200831-031057

File & folders 1.1.0-20200907-073046

Папка 2.2.0-20200831-031100

FTP / SFTP 2.1.0-20200825-071155

IF/ELSE 2.1.0-20200825-071156

Распознавание изображений 2.1.0-20200825-071159

Интерактивные формы 2.16.0-20200914-151814

IQ Bot 2.1.0-20200901-105449

JavaScript 2.1.0-20200831-031525

Имитация нажатия клавиш 2.3.0-20200901-093759

Legacy Automation 3.1.0-20200831-031532
1.1.0-20200825-071342

Список 2.2.0-20200831-031539

Записать в файл 2.2.0-20200831-031539

Цикл 2.1.0-20200831-031540

Message Box 2.1.0-20200831-031541
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Поддерживаемые пакеты

Пакет Версия

Миграция 2.5.0-20200902-045043

Мышь 2.1.0-20200831-031542

Число 2.1.0-20200831-031551

Распознавание текста (OCR) 2.2.0-20200825-071359

Office 365 Excel 2.1.0-20200825-071452

Календарь Office 365 2.1.0-20200825-071013

Office 365 OneDrive 2.1.0-20200825-071459

PDF 2.5.0-20200831-031836

PGP 2.2.0-20200831-031838

Ping 2.1.0-20200831-031839

Принтер 2.1.0-20200825-071516

Воспроизвести звук 2.1.0-20200825-071509

Запрос 2.1.0-20200824-092056

Python Script 2.1.0-20200831-031850

Средство записи 2.0.8-20201009-015051

Веб-служба REST 3.1.0-20200824-092129

SAP 2.2.0-20200825-071614

Экран 2.1.0-20200825-071618

SNMP 2.1.0-20200825-071620

Служба 3.0.0-20200821-060952

Веб-служба SOAP 3.1.0-20200827-210959

Строка 3.1.0-20200831-031943

Система 3.0.0-20200831-031944

Задача 2.0.1-20200907-072949

Эмулятор терминала 3.3.0-20200831-031950

Trigger Email 1.1.0-20200903-114514

VBScript 2.1.0-20200831-031953

Ожидать 3.1.0-20200831-031955

Окно 2.1.0-20200813-181240

Рабочая нагрузка 2.1.0-20200825-071644

XML 2.1.0-20200831-031958
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Измененные функции

Enhanced Capture area action in Распознавание текста (OCR) пакет
The Capture area action now captures text from the visible area of the screen even if the target
area is below the visible screen. Previously, the бот showed an error when the captured area was
below the visible screen.
Using Capture area action from Распознавание текста (OCR) пакет

Bot Scanner update
The Bot Scanner now displays error messages for боты that cannot be migrated to Enterprise
A2019 in the summary report.

Анализ отчета Bot Scanner для миграции

Flow view update
A line number is now displayed for each action in the Flow view of the Bot editor.

CSV/TXT пакет update
The CSV/TXT пакет processes a space as character. For example, if your CSV or text file includes
January, "March, April", then the output is displayed in the following format:
Январь
"March (space before the double quotation mark)
April"
If the CSV or text file contains the same information but without a space between January and
March (for example, January,"March, April"), then the output is displayed in the following
format:
Январь
March, April

Upgrade for resilient бот deployment
After you upgrade the Control Room and Bot Agent to Enterprise A2019.16, scheduled and queued
боты are not terminated. This is part of the resiliency improvements where the Control Room and
Bot Agent are set in a consistent state. As a result, the device reconnects to the Control Room if
there are any network disruptions, and scheduled and queued боты are deployed.

Важное замечание:  During the upgrade to Enterprise A2019.16, all боты that are running will
be terminated. After the upgrade, if the system is in an inconsistent state, restart the Bot Agent so
that the system is in a consistent state.

Internet Explorer waits for completion before initiating Средство записи action
When you use the Средство записи пакет, the бот now waits for the Internet Explorer browser
to finish loading the page before executing any action. This enhances the reliability of the бот by
preventing it from failing while the page is loading. For example, the Средство записи does not try
to search the object before the web page is fully loaded.
Using the Capture action
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Измененные функции

High availability enhancement
Starting from this release, configure the required minimum three Control Room nodes in an
Enterprise A2019 data center cluster for high availability deployment.
High availability deployment

The following table lists the fixed features and the builds in which they were fixed (Сборка 6463 is the
latest build, and Build 6453, and Build 6448 are previous builds). The fixes are cumulatively available in the
latest build.

Исправленные функции

Build number ID обращения к
облачному сервису

Описание

6463 00644915 The Bot Agent now checks for additional
SSL certificate from the Windows
CERT_SYSTEM_STORE_LOCAL_MACHINE
system stores in addition to the Java Credential
Store. This allows the Bot Agent to be updated
automatically from an earlier release to this
release.

6463 00666880, 00670899,
00672441, 00670455,
00672346

Бот files or dependencies are no longer lost
when you check in or check out a бот from
the private or public workspace. Previously,
an error occurred while either checking in
or checking out a бот, and the бот files or
dependencies were lost and could not be
recovered.

6463 00664020 You can now successfully run a бот that
contains the Capture action from the
Средство записи пакет with both the
HTML InnerText and InnerHTML object
properties selected.

6463 -- Fixed an issue where the Universal Recorder
failed to perform a click, set text, or append
text action on the correct control in Google
Chrome when a debug window or download
bar was open.

6453 00669040, 00669164,
00668923, 669332,
00669473,00671509,
00669178

The Automation Anywhere Elastic Search
Service now restarts during the certificate
retrieval process when you upgrade from
Enterprise A2019.15 to Enterprise A2019.16.
However, if you encounter any issues with the
Automation Anywhere Elastic Search Service
during the restart, see Automation 360 v.16
upgrade error: Elasticsearch Service fail to start
during certificate retrieval process (A-People login
required).
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Исправленные функции

Build number ID обращения к
облачному сервису

Описание

6448 00573048 You can now preview table variables in debug
mode and validate the бот logic. Previously,
watch variables containing Japanese and
Chinese characters did not display values in the
table variable.

6448 00656475 The Бот Deploy API call now consecutively
executes all the runAs users that are set in the
runAsUserIds parameter.

6448 00569832, 00628474,
00656267

The device registration issue due to Bot Agent
version extraction is now fixed. The exception
of "for input string null" no longer
occurs.

6448 00609073 You can now successfully integrate your
Control Room with your remote Git repository
without any error. Previously, the Git
integration failed because of a 404 error.

6448 00632444, 00626829,
00667531

When you import a main task containing
subtasks using the overwrite option, the
dependent subtask references are no longer
deleted for other existing main tasks that use
the same subtasks. As a result, the execution
of other main tasks containing the same
dependent subtasks does not fail.

6448 00501208, 00572346 For the Create user event name, the audit
log now properly displays the username who
created that user in the Event Started By
column. Previously, the same column did not
display any value.

6448 00616202, 00637626,
00653919, 00664039,
00664744

When the debug log is enabled in logs
configuration and you use the For each row
in a SQL query dataset option from the
Цикл action to iterate each row, the iteration
now completes without any error. Previously,
the iteration failed because of a change in the
debug log configuration.

6448 00653064 After the caching service is restarted, the бот
execution no longer fails. The caching client
instances are reconnected and reinitialized
after the restart.

6448 00577612 In a бот with dependencies, if you check out
and edit a child бот in your private workspace
and later check out the parent бот, you will no
longer lose the changes made to the checked-
out child бот. Previously, changes made to the
child бот were overwritten.
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Исправленные функции

Build number ID обращения к
облачному сервису

Описание

6448 00623154 When a Bot Creator that does not have
create folder permission tries to check in a
бот to the public workspace, an appropriate
error message is now recorded in the audit
log, indicating the specific reason for the
failure. Previously, the audit log recorded an
unexpected error occurred message.

6448 00622977 In the Edit role page, file permissions are
now correctly aligned in Internet Explorer.
Previously, the Delete from Public option
was displayed below the Select all option. As
a result, the folder and permissions were not
placed next to each other.

6448 00615437 You can now migrate MetaBots that contain
input and output type variables with a
description containing unsupported characters
such as quotation marks (") and forward slash
(/).

6448 00636169 The Control Room now disables a user account
when the number of consecutive failed login
attempts specified in the Control Room settings
is reached or exceeded.

6448 00530550 A variable now returns the correct value when
the regional setting of the device is set to the
Brazilian metric system.

6448 00604893 A бот no longer encounters an error when the
system cannot finish pre-processing the бот
due to an ignite cache issue.

6448 00578277 An error is no longer encountered when the
Connect and Disconnect actions of the SAP
пакет are used in a loop and the iteration is
set to more than 500 times.

6448 00635890 The Bot Scanner now scans all the боты in a
repository and displays the correct count of
child боты.

6448 00634238 You can now use the form builder in Internet
Explorer (version 11 or later) to add more
items to the Checkbox and Radio Button
elements without encountering any issues.

6448 -- For the Select file element, you can now
upload a file with a dot (.) in the filename. For
example, Sales.March.jpg.

6448 -- Software version notification for Cloud was not
always displayed in the UI. This issue is now
fixed.
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Исправленные функции

Build number ID обращения к
облачному сервису

Описание

6448 00633793 You can run a бот when the operational
parameter is used in the SOAP Web Service
action. Previously, the бот encountered errors
when the operational parameter was used in
the action and the corresponding wsdl file
did not have the elementFormDefault
attribute.

6448 00630975 Captured images in a nested If action are now
retained when you check in a бот to the public
repository. Previously, when using any action
that used an image in a nested If action, the
image nested was missing after the check-in.

6448 00630004 When loop is used to read all Unread emails,
the emails are now marked as Read only after
emails are read. Previously, all unread emails
were marked as read when a Loop Break
action was used.

6448 00612913 In Excel Advanced > Remove blank rows,
when you select the Specific row option and
set A1 as the beginning cell, an error is no
longer encountered when you run the бот.

6448 00608265 In the CSV/TXT пакет, when you use Japanese
OS ANSI (Shift-JIS) as encoding to read text
file content, the Japanese Shift-JIS characters
are now displayed correctly.

6448 00568718 Japanese language supported pop-up
messages no longer appear truncated when
multiple боты are deleted.

6448 00598023, 00611480 In the DLL пакет, Run function now works
properly and does not display an error or
show broken characters when the parameter
includes Japanese characters.

6448 00638120 When you upgrade from an earlier version of
Enterprise A2019 to a later version and change
the If пакет version to the latest one, multiple
conditions now appear in If/Else If after the
If пакет is upgraded. Previously, some of the
conditions did not show in the logic.

6448 00632228, 00649606 You can now use the Send Email action when
the пакет version is different in the task and
subtask. Previously, the Send Email action in
the Email пакет had issues when the task and
subtask had a different пакет version.
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Исправленные функции

Build number ID обращения к
облачному сервису

Описание

6448 00544219, 00635206 The Get cell action in Excel Advanced can
now be used without any error. You can use
the Read option to read visible data or the
exact value of the cell.

6448 00646254, 00650712,
00653137, 00658122,
00666883

You can now change the пакет version of the
If пакет. Previously, if there were multiple
conditions in the If action, the system did not
allow you to change the пакет version.

6448 00613453 Version 11.3 боты that used the Object Cloning
command to find interface objects using
coordinates or image recognition are now
migrated to Enterprise A2019 with the Mouse
> Click action, Simulate keystrokes action,
OCR > Capture area action, or Image
recognition > Find window in window
action.

6448 -- When you run migrated боты that perform
mathematical operations on values containing
decimals or commas, the output from
Enterprise A2019 now matches the output
from Version 11.3.5. Previously, an operation
that resulted in an output of 0.999 in Version
11.3 resulted in an output of 0.9899999 in
Enterprise A2019.

6448 00467664 Fixed an issue where the Universal Recorder
entered characters in a text box incorrectly
when the user configured the Keystrokes
field using a Japanese keyboard.

6448 00630545, 00631418,
00621875

You can now assign input values from a parent
бот in the Task Bot > Run action. Previously,
an issue caused input values to disappear
when a бот containing more than two input
values was saved.

6448 -- The Рабочая нагрузка In progress activity
page now displays the Рабочая нагрузка бот
name instead of the automation name.

6448 00635306 Fixed an issue where a red error screen
appeared if a бот attempted to pass a file
variable to another бот.

6448 00635326 You can now run боты built using Средство
записи пакет versions from earlier builds.

6448 00616261 You can now pass credential values to the main
бот when you deploy it from the Run bot
now page.
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Исправленные функции

Build number ID обращения к
облачному сервису

Описание

6448 00647135, 00647652,
00647665, 00647144,
00648742, 00646535,
00648883, 00648980,
00654937, 00657039,
00664049, 00663797,
00664138, 00667384

When you upgrade to the latest version of
Enterprise A2019, боты in queued state now
run without any issues because a new token
is automatically generated when an existing
session expires.

6448 00611109 Fixed an issue where the $System:CPUUsage
$ system variable returned an inaccurate value.

6448 00647239 In the Таблица данных пакет, when you use
the Merge action to merge two data tables,
the data is now properly merged and the
merged content stores the correct data in the
result data table. Previously, the Merge action
had issues when no header data in a table was
extracted, resulting in incorrect data export to
CSV file.

6448 00444907, 00556374,
00582469, 00628801,
00624681, 00632668

A бот launcher error for a user session is no
longer displayed when you run a бот on a
Bot Agent device registered to a user who is
assigned developer privileges.

Исправления в системе безопасности

ID обращения к облачному
сервису

Описание

00552076 The vulnerabilities found in Elasticsearch in Enterprise A2019
are now addressed.

00631233 In the База данных пакет, when you connect to the database,
the username and password are no longer visible in the logs.
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Известные ограничения

When you are upgrading from an earlier version of Enterprise A2019 to the current version, the
system displays the error message Self Sign Certificate Failure, and the installation
process is rolled back if both the following conditions occur:
1. The earlier version was installed on a non-default installation path instead of the default path

(C:\Program Files\Automation Anywhere\Enterprise). For example, the previous
version was installed on D:\Program Files\Automation Anywhere\Enterprise.

2. You also select Yes to retain the current installation parameters during upgrade in the message
window that appears after the Welcome screen when the installation wizard detects an earlier
version.

Обходное решение. Select No so that you can choose to enter the installation parameters
during the upgrade.
Control Room upgrade fails with self signed certificate failure error (A-People login required)

Service Cloud case ID: 00672719, 00673048
When you are upgrading the Control Room to the current version, the installer uses an
existing or creates a new Elasticsearch data folder in the default path (C:\ProgramData
\AutomationAnywhere\elasticsearch\data) if the Elasticsearch data from the earlier
version is saved to a non-default path. Therefore, the earlier Elasticsearch data and audit logs will
not be available after the upgrade.
Обходное решение. Before upgrading to the current version, copy the existing Elasticsearch
data from the non-default path to the default path.

When an Automation Anywhere package is manually uploaded using the Control Room interface,
the Vendor column should show Automation Anywhere. Instead, the interface displays
Unspecified. Automation Anywhere packages that are installed on a server as a part of an
upgrade show the Vendor as Automation Anywhere, which is expected.

For existing device sessions, you cannot use the option to enforce the resolution set at either the
device or Control Room level. The screen resolution set at these levels only work for new device
sessions.

When attended and unattended Bot Runner are run concurrently, attended Bot Runner users
are queued until the unattended Bot Runner session becomes available. This occurs even when
the number of allowed concurrent sessions is not exceeded. For an attended Bot Runner user
deployment, use a single user session to stop them from being queued.

When a user connects to a multi-user device and sets it as their default device, they are taken
through the device registration wizard to enable the Google Chrome plug-in. During the registration
process, users are allowed to select the device type and the concurrent sessions value. Users must
ensure that they set the same value for the concurrent sessions as set by the administrator. If there
is a difference in the value, other users will be impacted.

When a бот is deployed through RDP with a predefined screen resolution, the RDP resolution
settings are not applied correctly during бот execution. The бот is executed with an interchanged
resolution (the height and width pixels are interchanged). For example, if the resolution for бот
deployment is set as 1366x768, the бот is deployed with the resolution 768x1366.
Обходное решение. For information about how to resolve this issue, see Automation 360 v.16 -
RDP based deployment does not run bot with pre-defined set screen resolution (A-People login required.

The element label or text appears distorted during бот runtime when you add it in Japanese or any
other non-English language, and the Font name is set to System default.
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Известные ограничения

Service Cloud case ID: 00667210
In Расширенный Excel, you cannot use the Go to cell action if the Excel sheet does not have data
or if an active cell is out of the worksheet range. This issue is encountered when you use the Go to
cell action and choose the cell option as Active cell with the Beginning of the row, End of the
row, Beginning of the column or End of the column option.
Обходное решение. Use the earlier version of the Расширенный Excel пакет
4.0.0-20200723-234413 released with Enterprise A2019.15.

HTTP authenticated proxy is not supported for On-Premises users.

Discovery Bot

Новые функции

Discovery Bot installer integrated with Enterprise A2019 installer
Enterprise A2019
The Discovery Bot installer is now integrated with the Enterprise A2019 installer. Для
пользователей Discovery BotOn-Premises отдельная установка не требуется. Discovery Bot
supports custom installation for Windows.

Необходимые условия для Discovery Bot

Create multi-role users
Enterprise A2019
Combine up to three Discovery Bot system-generated roles and two process discovery licenses to
provide additional functionality for your users.
Create multi-role users for Discovery Bot

Create custom role user
Enterprise A2019
Create a unique custom role using the permissions from the Discovery Bot standard user roles
(Admin, Business user, or Analyst roles).
Create a custom role for Discovery Bot

Manual aggregated view integrated with Dashboard tab
Enterprise A2019
The Manual aggregated view is now integrated with the Dashboard tab. You can now select
and display recordings and views from the Dashboard, Aggregated, and Comparison tabs,
enabling you to make a change in one tab that will persist across all tabs. This feature enables a
synchronized representation of your metadata for views and recordings.
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Новые функции

Internalization, localization, and language support for Discovery Bot
Enterprise A2019
Internalization and localization is now supported for Discovery Bot. For example, you can automate
and translate the UI for your region in French, Spanish, and Italian, among other languages
supported.

Интернационализация, локализация и поддержка языков

Исправленные функции

ID обращения к облачному
сервису

Описание

-- You can now sort on the recording ID. The recent recording
(ID) created now displays at the beginning of the list in the
Recordings table.

-- When editing the aggregated view, you can now move the
endpoint upward in the path flow to change the selection of the
steps. You can also move the branch endpoint lower in the path
flow to include more than one step.

-- You can now select partial steps in a branch, and create and
save an opportunity from the Opportunities tab.

-- The copy field now displays the correct view information from
the view (view ID) that it is copied from.

00673381 If you are using an instance in an AWS special region, you can
now view recordings for users that are successfully completed
(not canceled by the user).

Известные ограничения

When manually editing an aggregated view, if you create a branch in the process flow where a step
was deleted, the step will be missing on the left side of the branch. To add a step on the left side,
you can drag the branch endpoint (small circle) down (below the next step) in the process flow to
add a step back in the branch.
Missing step observed in aggregated view while using A2019.16 Discovery Bot (A-People login required)

When an opportunity is created with 300+ steps, exporting the opportunity to Microsoft Word will
fail.

The Convert to Bot option fails when an opportunity contains 140 or more steps.

IQ Bot Community Edition

The IQ Bot Community Edition is available for this release and has feature parity with IQ Bot Version
11.3.4.2.

Матрица сравнения функций Automation 360 IQ Bot

Automation 360 IQ Bot version compatibility

© 2023 Automation Anywhere. All rights reserved.     536

https://apeople.automationanywhere.com/s/article/Missing-step-is-observed-in-the-aggregated-view-while-using-Discovery-Bot


    Automation Anywhere - Learn

Важное замечание:  This new Community Edition includes a preview of IQ Bot with Auto-extraction.

Community Edition for IQ Bot is a special version of our product in the Cloud, available for all users who
want to try RPA and IQ Bot at no cost. Пользователям не требуется приобретать лицензию, и нет
ограничений по времени. Однако существуют следующие функциональные ограничения:
• Users can create learning instances using pre-trained Invoices in English only.
• Users can create up to a maximum of 5 learning instances per user account.
• In the Learning Instance list, users can see and access only those learning instances and data created

by them.
• Users can process up to a 100 pages per month for each user account.

Community Edition

New features (using auto-extraction)

Создание обучаемого экземпляра
Use a pre-trained invoice (document type) to process and validate your documents in English
(only).

Создание обучаемого экземпляра в Community Edition

Extract data from documents
Create a бот to extract data from documents using the learning instance you created.

Validate documents
Validate failed documents manually using the validator form.

Обработка документов в Community Edition

Bot Insight integration
View learning instance dashboard metrics that is integrated with Bot Insight.

Use the IQ Bot (Preview) пакет
Use the IQ Bot (Preview) пакет to process and validate documents using Enterprise A2019.

Измененные функции

For the Custom Logic feature, the identified list of Python libraries now includes an additional set
of safe libraries for IQ Bot Community Edition. Go to Automation Anywhere support for a list of the
safe libraries you can use.
List of Pandas Libraries which are supported and not supported on Automation 360 IQ Bot (A-People login
required)

Fixed features (using Auto-extraction)

ID обращения к облачному
сервису

Описание

00628958 The TaskBot now successfully processes all documents without
displaying any error messages.
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Known limitations (using Auto-extraction)

PDF documents with raster format or JBIG2 encoding are not supported.
Обходное решение. Convert such documents to one of the supported formats before processing
your documents for data extraction.

Прим.:  Digital PDFs, JPEG, JPG, and PNG are supported formats.

Rotated documents are not supported.
Обходное решение. Pre-process such documents to correct their orientation before data
extraction.

Only a predefined set of form and table fields are supported. The table header does not support
multiple fields in a single column.

During the validation process, if a user deletes all rows from a table, the user is unable to add a
new row.
Обходное решение. Perform these steps:
1. Cancel the validation user form and open the document again.
2. Create a new row before deleting the unwanted rows.

Documents that are pending review from Enterprise A2019.15 cannot be validated in Enterprise
A2019.16 using the Review documents option.
Обходное решение. Create a TaskBot using the IQ Bot Validation action in the Enterprise
A2019.15 пакет, and validate the review pending documents.

IQ Bot

Новые функции

Updates to IQ Bot Pre-processor пакет
On-Premises и Cloud
You can now perform the following tasks using the new actions in the IQ Bot пакет:
• Link or combine two images using Concatenate image
• Adjust the size of the selected image file using Edit image
• Enhance the image resolution and other aspects using Enhance image
• Change the image orientation such as angle using Orient image

IQ Bot Pre-processor пакет

IQ Bot [Local Device] пакет enhancements
The IQ Bot [Local Device] пакет now enables you to add custom logic (Python scripts) in the
Designer to extend text extraction and validation capabilities.
Add custom logic in IQ Bot to improve extraction
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Исправленные функции

ID обращения к облачному
сервису

Описание

00590165 You can now train the selected document because error
messages are no longer displayed when you click Learning
instances > See extractions for a group.

-- If you remove a бот (Delete a bot) associated with a
document from the staging environment, you must create
a group before uploading this document to the production
environment. After deleting the бот from the staging
environment, you can now create or edit the group when you
upload the same document to the production environment.

00601840 You can now view a public бот without any errors when you
click BOTS > My bots > PUBLIC in Enterprise A2019.

00672482 You can now validate documents with a large number of fields
(more than 100) and navigate between multiple documents
without any issues on the Валидатор.

00648013, 00670191 You can now migrate, export, import, or download IQ Bot
learning instance backup (.iqba) files of up to 1.4 GB. The
previous limit was 600 MB.

Известные ограничения

Migration of learning instances does not get completed if the IQBA file size is more than 2 GB.
Обходное решение. Migration of learning instance is not getting completed if the IQBA is more than
2GB (A-People login required)

In the IQ Bot Designer, sometimes while training documents when the user clicks See extraction
results, an error message appears and the user cannot proceed with the task.

You cannot access Cloud Распознавание текста (OCR) through a proxy server in IQ Bot.

In IQ Bot Community Edition, when you click New instance to create a learning instance, the My
learning instances page appears and then automatically reloads after a few seconds.
Обходное решение. Wait until the page reloads before you start entering the details to create a
learning instance.

Bot Insight

Новые функции

Power BI connector available as part of Microsoft Power BI desktop
Enterprise A2019 and Community Edition
The Automation Anywhere connector for Bot Insight is now certified and officially a part of the
Microsoft Power BI Desktop August release.
Data connector for Power BI
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Новые функции

Business analytics support for attended Bot Runner
Enterprise A2019 and Community Edition
Business analytics data is now logged when боты are run with attended Bot Runner licenses. Also,
a new attribute User Name is available in the Business Dashboard in Transaction Data. This
attribute shows the user who is running the бот.

Измененные функции

Convert бот duration metric to percentage
In the Device dashboard, when you select the metric as Bot Duration, you have an additional
option to convert the бот duration to percentage. This option appears only if a selected group or
subgroup is of date type variable.
Operations dashboard

Известные ограничения

Due to security reasons, you cannot access the following Bot Insight APIs and a 403 forbidden
error is displayed.

GET/v2/botinsight/data/api/gettasklogdata
GET/v2/botinsight/data/api/gettaskvariableprofile
DELETE/data/api/deletetasklogdata
GET/data/api/getbotrundata
GET/data/api/getaudittraildata

Automation Anywhere Robotic Interface (AARI)

Важное замечание:  This AARI version is available for all users starting from Enterprise A2019.16.

Новые функции

Assign tasks
Enterprise A2019
AARI managers and users can now assign tasks. Managers can assign and reassign tasks to any
users from teams with an assigned process. Users can assign tasks to other users of the same
team.
Assign or unassign a task
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Новые функции

Filter and search tasks
Enterprise A2019
AARI users can now perform the following tasks:
• Filter, sort, and search tasks for quick results
• Search task names using Search Title
• Sort by completed, pending, and unassigned tasks using the Filter option
• Configure results based on assignee or title using Advanced filter
• Click a column to sort by ascending or descending orders

Фильтрация и поиск задач.

Summarized information of tasks
Enterprise A2019
The Tasks tab in the main page shows statistical insight for the numbers of completed, pending,
and unassigned tasks.

Process пакет
Enterprise A2019
The Process package enables users to create a request inside a specified process from a бот.
Process пакет

Preview бот
Enterprise A2019
Human Tasks and Bot Tasks now include the Preview bot option, which enables users to
quickly preview relevant бот or forms information.

Process editor metadata
Enterprise A2019
Human Tasks and Bot Tasks now accept username and email metadata. Users can enter the
name and email values to their process workflow such as $Task.assignedTo{username}$ and
$Task.assignedTo{email}$.

Enhancements to roles
Enterprise A2019
The AARI admin can now assign a process to a team they created and become the manager
assigned to that process. The admin can also assign a process to a team they did not create and
the manager of that team is assigned to the process.

Administration permission
Enterprise A2019
The AARI admin and manager are now assigned a new Administration permission by default
called View Users and Roles basic information. The admin can now view the process
management page to assign or unassign managers.
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Измененные функции

Process management page
The process management page in AARI on the web is now removed for managers.

Password field in request view
The Password element is now removed when viewed in the request tab.

Исправленные функции

ID обращения к облачному
сервису

Описание

-- A team name is no longer limited to 20 characters.

-- When you open many request tabs, the navigation bar now
functions properly and allows you to navigate to your tabs by
using the arrow icon.

-- When you view tasks in the request view, the request and task
now show the correct status.

-- The manager can now be removed in the process management
page.

-- The бот status in the request view is now represented as a
progress bar.

-- The Element name field in the process editor now shows the
correct error message when the field contains spaces.

-- When you select the Make field uneditable option for the
Checkbox, Date, Dropdown, Number, Password, Radio
Button, Text Area, and Text Box elements, the values can no
longer be edited.

-- The team management page now shows the Owner column.

-- When number values are entered in a number field, such as a
phone number box, the values are now accepted.

-- In the device pool configuration page, the Bot Runner users
check box is now selected.

-- The Checkbox and Radio Button elements now support
horizontal format.

-- The Document element can now access the Open the doc in
browser link.

-- The Number element values are no longer limited to 8
characters and can now be rendered properly when the values
contain trailing zeroes, commas, and decimals.

-- When you select the Insert a variable option in the process
editor, the Variable field now shows specific variable names.

-- The redo functions now works properly in the process editor.

-- The Text Box element now accepts number-only inputs.
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Исправленные функции

ID обращения к облачному
сервису

Описание

-- The timestamp of the closing step now shows the timestamp of
the last step in request view.

-- When you access a public process, the existing variable in the
field can no longer be changed.

-- The Masked data option is now fully supported for all
elements.

-- When you edit a checked-out process that contains conditional
steps with variables, you can now edit and save these
conditional steps.

-- When a process is configured with two forms that contain
a Dropdown element, the process creation shares the
Dropdown element data between the forms. The Dropdown
element in the second form now receives data from the first
form.

-- The manager can now access their team without encountering
any errors.

-- You can now update values in a prepopulated text field in
request view.

-- When you create a request and encounter a preprocessing error,
the request creation ends and the request view now shows the
failed status.

-- The Go To option in the process editor now shows the Human
Task or Bot Task name.

-- Users with the AARI manager and user roles are now
automatically redirected to the web interface when they access
the Control Room URL.

Известные ограничения

When you provide your Bot Task and Human Task the same element name, an error occurs for
the Go to element, but the process editor does not prompt an error.
Обходное решение. Create unique element names for your Bot Task and Human Task.

When you create a form that contains a Document element and access your Human Task in the
process editor, you cannot assign your variable because the Add element option is not available.

The Display message field in the If/Else pair action does not function correctly when displaying
a message in request view.

The titles (Title field) of completed requests in AARI on the web are replaced by endpoint display
names.

When you create a form that contains a Number field set to a 10-character limit and you enter
1234567890 in the number field in request view, the number values are not accepted.
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Известные ограничения

When you create a process with a form that contains a Date element, the Condition option in the
If/Else pair action does not allow you to enter a variable.

Previous Automation 360 Release Notes
Review the release notes for previous Automation 360 releases.

Enterprise A2019.15 Release Notes

Дата выпуска: 14 August 2020

Review the new features, supported packages, changed features, fixed features, security fixes, and known
limitations in the Enterprise A2019.15 (Сборка 5933) release. IQ Bot and Discovery Bot are on Build 5931.
• Enterprise A2019 on page 544
• Discovery Bot on page 553
• IQ Bot on page 555
• Bot Insight on page 558
• Automation Anywhere Robotic Interface on page 559

Enterprise A2019

To verify which  version is compatible with this release, see Compatibility with release builds on page 1033.

Новые функции

Introducing Discovery Bot and Automation Anywhere Robotic Interface
Enterprise A2019
Discovery Bot on page 553 | Automation Anywhere Robotic Interface on page 559

Migration from Enterprise 11 and Enterprise 10 to Enterprise A2019 (currently available
only to those in the Migration Early Adopter Program)
Enterprise A2019
Migration to Enterprise A2019 is currently only available to select customers through our Migration
Early Adopter Program. If you are interested in learning more about this program or a timeline
for when migration will be available to all customers, contact your Automation Anywhere
representative.

Perform an action on multiple objects of the same type
Enterprise A2019
The variable anchor in AISense Recorder enables you to perform an action on multiple objects of
the same type.
Use variable anchor
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Новые функции

Run Enterprise 11 боты from Enterprise A2019
Enterprise A2019
The V11 TaskBot пакет enables you to run Enterprise 11 боты from Enterprise A2019 in the
Enterprise 11 Control Room.
V11 TaskBot пакет on page 1932

Enhancements to the Interactive forms
Enterprise A2019
Interactive forms include the following updates:
• You can include the Dynamic element of the selected form in the Change label action.
• In the Dynamic area actions:

• You can add a maximum of four elements for the Add row in Dynamic area action.
• In the Add element screen, use additional options from the Type drop-down menu such as

Checkbox, Dropdown, File, Snapshot, RadioButton, Text Area, and TextBox.

Interactive forms пакет on page 1651

Support for interactions with Oracle EBS tables
Enterprise A2019 and Community Edition
Use the Universal Recorder or the Recorder > Capture action to read data from an Oracle EBS
table. The following actions are now supported:
• Get Total Row
• Get Total Column
• Get Cell text by Index
• Get Cell index by text

Expanded data type support in DLL пакет
Enterprise A2019 and Community Edition
The DLL пакет now accepts dictionary and list variables as input parameters or to hold action
output.
Using the Run function (Legacy) action on page 1500

Create device pools using API
Enterprise A2019
You can now create a device pool and add unattended Bot Runner to the device pool using an API.
This API uses deviceIds, automationScheme, ownerIds, and consumerIds as parameters to
create a device pool.
Device Pools API

Поддерживаемые пакеты

Пакет Версия

Node Manager 12.1.6000
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Поддерживаемые пакеты

Пакет Версия

Приложение 2.0.0-20200721-221935

Интеграция приложений 1.0.0-20200721-221933

Анализ 2.2.3-20200624-011702

Active Directory 2.0.1-20200721-221930

Логический 2.0.0-20200721-221936

Перенос ботов 2.4.0-20200604-174031

Браузер 2.0.0-20200721-221938

Буфер обмена 2.0.0-20200721-221947

Комментарий 2.0.0-20200721-221948

CSV/TXT 2.0.0-20200726-052504

База данных 2.0.0-20200723-022707

Таблица данных 2.0.0-20200721-222456

Дата/время 3.0.1-20200721-222000

Задержка 2.1.0-20200721-221959

Словарь 2.0.0-20200624-041629

Run DLL 2.0.0-20200721-222437

Эл. почта 2.0.0-20200721-222003

Обработчик ошибок 2.0.0-20200721-222009

Базовый Excel 2.0.0-20200721-222339

Расширенный Excel 4.0.0-20200723-234413

Файл 2.1.0-20200624-041638

File & folders 2.1.0-20200721-222011

Папка 2.1.0-20200721-222013

FTP / SFTP 2.0.0-20200721-222017

IF/ELSE 2.0.0-20200721-222021

Распознавание изображений 2.0.0-20200721-222024

Интерактивные формы 2.15.0-20200729-084624

IQ Bot 2.0.0-20200415-125005

JavaScript 2.0.0-20200721-222202

Имитация нажатия клавиш 2.1.0-20200721-222204

Legacy Automation 2.0.0-20200721-222207
1.0.0-20200515-133334

Список 2.0.0-20200721-222211

© 2023 Automation Anywhere. All rights reserved.     546



    Automation Anywhere - Learn

Поддерживаемые пакеты

Пакет Версия

Записать в файл 2.1.0-20200721-222212

Цикл 2.0.0-20200721-222213

Message Box 2.0.0-20200721-222213

Миграция 2.4.0-20200728-033126

Мышь 2.0.0-20200721-222218

Число 2.0.0-20200721-222224

Распознавание текста (OCR) 2.1.0-20200721-222225s

Office 365 Excel 2.0.0-20200721-222319

Календарь Office 365 2.0.0-20200721-221944

Office 365 OneDrive 2.0.0-20200721-222326

PDF 2.4.0-20200721-222331

PGP 2.1.0-20200721-222333

Ping 2.0.0-20200721-222334

Принтер 2.0.0-20200721-222342

Воспроизвести звук 2.0.0-20200721-222335

Запрос 2.0.0-20200721-222344

Python Script 2.0.0-20200721-222345

Средство записи 2.0.6-20200626-193519

Веб-служба REST 2.0.0-20200721-222436

SAP 2.1.0-20200723-234637

Экран 2.0.0-20200721-222442

SNMP 2.0.0-20200721-222445

Веб-служба SOAP 3.0.0-20200721-222448

Строка 3.0.0-20200721-222454

Система 2.0.0-20200721-222454

Задача 2.0.0-20200624-103759

Эмулятор терминала 3.2.0-20200721-222500

Trigger Email 1.1.0-20200721-222511

VBScript 2.0.0-20200721-222503

Ожидать 3.0.0-20200721-222505

Окно 2.0.0-20200721-222507

Рабочая нагрузка 2.0.1-20200721-222508

XML 2.0.0-20200721-222509
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Измененные функции

User validation for change in authentication type (Service Cloud case ID: 00602788)
Enterprise A2019
The username is now validated when an admin user updates the Control Room authentication
configuration from Database to SAML (Administration > Settings > User Authentication).
An error message appears if the username already exists.

Настройка аутентификации SAML on page 1001

The Before and After fields in the String > Extract action are now optional (Service Cloud
case ID: 00617151)
Enterprise A2019 and Community Edition
Users can now build and run боты that do not have a value in the Before or After fields. This
ensures migrated боты that contain the String > Extract action can run without disruption.

Improved debugging for Распознавание изображений actions
Enterprise A2019 and Community Edition
When a бот fails while running one of the Распознавание изображений actions, the captured
source and target images are stored in the log folder. Users can review the images to identify issues
such as the application image not captured correctly or low quality of the image due to differences
in the Bot Creator and Bot Runner devices.
Image Recognition пакет on page 1645

Исправленные функции

ID обращения к облачному
сервису

Описание

00609293 The AATaskName system variable now uses a backslash (\)
to support the migration of Enterprise 11 боты that use this
variable to Enterprise A2019.

00600367, 00620149 When calling REST APIs for using the Веб-служба REST
command, the API now returns the correct status and the
response code.

-- When Work Items are processed for automation in the Bot
Agent, you can now view the workload automation name in
the Workload > Queue > View Activity in progress and
Run bot with queue > View pages, even when the workload
automation ID and schedule automation ID are the same in the
Control Room database.

00606636 The migration of 11.3.x боты that read a date from a file to
an Enterprise A2019 variable now results in the correct date
format: dd/mm/yyyy. Previously, a series of numbers were
displayed in Enterprise A2019.

00576004 Fixed an issue where some emails were retrieved with HTML
tags, even when the user selected the Plain text option.
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Исправленные функции

ID обращения к облачному
сервису

Описание

00585830 Fixed an issue where the Loop > For each meeting in
calendar iterator only returned details for the first meeting of
the day. Now, the output variable refreshes after each iteration
and returns details for each meeting.

00505228, 00576757 When the browser language is set to Japanese, error messages
from the Control Room > Administration > Settings >
Email page are now displayed correctly. The distorted Japanese
character issue is now fixed.

-- You can now check in any forms or боты in the Public folder
that were created using any of the earlier versions of Enterprise
A2019.

-- You can now use the Get action without any errors for an
empty dynamic element of a form during бот runtime.

00575400, 00597633 You can now use Email trigger to start a бот even when
Microsoft Office is set to a non-English language.

-- If you are using the Snapshot element, the form is no longer
minimized even if you set an invalid file path to save the
snapshot during бот runtime.

00566225 If you add a form with a Japanese name, error messages are
not displayed during бот runtime.

00571773 If you have added element label or text in Japanese and set
Font name > System default, the form elements are now
displayed without any distortion during бот runtime.
Create a form on page 2202

00620911 For the Select file element in a form, the file path is now
displayed correctly when you select a file with a Japanese name
during бот runtime.

-- If a form has a Dynamic field, any errors within any of the
available elements are now displayed immediately during бот
runtime.

-- An error is now displayed if you use the Tab key to navigate out
of the Dropdown element in a form during бот runtime.

00616251 If a Bot Runner (attended or unattended) user is running a бот
and an event trigger that is associated with this user starts, the
event trigger is now queued and deployed after the current бот
has completed.

00557617 The Имитация нажатия клавиш action now supports ASCII
characters when the device language is set to Russian.

-- Installing cloud-based license files is now supported on Control
Room deployments using Linux CentOS 7.
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Исправленные функции

ID обращения к облачному
сервису

Описание

00615038 All пакеты and actions now work with the “Portuguese (Brazil)”
browser language. Previously, some пакеты and actions caused
an unresponsive Control Room when “Portuguese (Brazil)” was
selected as the browser language.

-- You can now reset the password successfully when the service
credential expires or is disabled. Previously, users intermittently
experienced issues while resetting the password.

-- The default logging for Bot Agent is no longer in debug mode.
Previously, debug mode was the default logging, which caused
an increase in the number of logs and resulted in high storage
space and decreased system performance.

00588077 If you create a copy or edit the content of an existing CSV file,
the modified content that is uploaded in the Control Room will
now display correctly and will not cause any run-time error
when the бот is executed.

00541524,00531540 You can now run боты even when the path of the бот location
is more than 255 characters. Previously, the бот failed with an
error.

00615106 The Bot Scanner now analyzes large боты within a few minutes.

00610366 Keyboard shortcuts such as Ctrl+C, Ctrl+V, and Ctrl+X work as
expected on Internet Explorer.

00577850, 00608065, 00597132,
00596397, 00619463

The Control Room now does not become unresponsive after a
period of inactivity.

00608824 An error is no longer encountered when a бот opens the Excel
application after it is forcefully terminated.

00542144 The wait option in various packages now works as expected
for applications based on HTML technology. Previously, the
wait option used to wait for a period in multiples of 15 seconds
based on the value provided. For example, if the wait value was
in the range of 1-14, the system waited for 15 seconds.

00508478, 00504802, 00569822 An error is no longer encountered when a бот is running and
an application window is closed when the бот is performing the
find window operation.

00494857 A user that does not have the Register device permission can
no longer register a device by creating a custom Bot Creator
role.

00501619, 00614130, 00620198 An error is no longer encountered when a user deletes a device
after upgrading to a later version of Enterprise A2019.
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Исправленные функции

ID обращения к облачному
сервису

Описание

00616786 Fixed an issue where periodic scheduled бот deployments failed
with the following error message (even though the credentials
provided by the бот is correct):
Either your username or your password is
incorrect. This might be due to a misspelling,
your Caps Lock might be on, the password might
have expired, or the domain might be required.
To continue, retype your username and password.

00494893 Fixed an issue where the Error handling > Catch action was
not handling a runtime error with the record variable. Previously,
the Catch action did not capture an index out of bounds
error when the record variable was entered in a Message box
action with the index specified by name.

-- The Get Property datetime format within the Active Directory
пакет now displays the information using the system datetime
format.

-- When you edit a бот using a previous package version (for
example, Enterprise A2019.13 version) and the Desktop
session automatically starts, if you exit the Bot editor while
the Desktop session is trying to launch, the current package
version will now be displayed when you open a new Bot editor
instance. Previously, the previous package version (for example,
Enterprise A2019.13 version) was displayed.

00563346 Credentials with non-ASCII characters are now allowed to be
stored in the Credential Vault in the Control Room. Therefore,
when you run TaskBots to open files that are protected using
passwords containing non-ASCII characters, the application
does not respond with an HTTP 500 error.

00525552, 00470841 The Run task no longer fails when the child бот name contains
allowed special characters. Previously, when the child бот name
contained allowed special characters, the run task displayed an
error message.

00501212 Fixed an issue in the SMTP settings where the Control Room
was sending notification emails for all of the conditions,
including the disabled conditions.

00607005 A security scan of Enterprise A2019 no longer reports the
Средство записи пакет as a malicious software. Previously, the
security scan reported it as a malicious software because the
check.exe file was missing the root identification certificate.

00564129 On an operating system configured for Japanese, the Roles
pages in the Control Room now shows English text as expected
when you select English in the Control Room language selection.
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Исправленные функции

ID обращения к облачному
сервису

Описание

00629523 When you upgrade from an earlier version of Enterprise
A2019 to a later version and change the Если пакет version
to the latest one, conditions combined with the AND or OR
condition now appear in the logic. Previously, except for the
first condition, the rest of the conditions with the AND or OR
condition were not shown.

00631477 When Work Items from multiple queues are processed for
Рабочая нагрузка automation from one device pool with the
round-robin method for a time slice of 5 minutes, the Рабочая
нагрузка automation does not run in a loop and thereby
causing an increased CPU usage.

00633829 As system admin permissions for Рабочая нагрузка automation
are verified by the application when you run a бот with queue
from a single device pool to process multiple Work Items
concurrently, CPU usage does not increase drastically.

00615086 Fixed an issue where the Java Application Launcher continued to
run after a user stopped the Bot Scanner, which caused device
performance issues for some users.

-- Variables of the List type are now available for migration from
Enterprise 10 andEnterprise 11 to Enterprise A2019.

00607949 Disabled packages will not be enabled when you upgrade
from an earlier version of Enterprise A2019 to a later version.
Previously, packages that were disabled were enabled after an
upgrade.

-- You can now debug a бот with watch variables that contain
Japanese characters. Previously, watch variables containing
Japanese characters did not output a value.

00623186, 00624876, 00624060,
00627123, 00629873, 00639523,
00630880, 00634577, 00636166

The correct status of a deployed бот now appears instead
of Device yet to be determined in the Control Room
Activity page, and the user is allowed to delete the device that
has completed running a бот. The following message no longer
appears: Device is part of active deployment.

00573461 Fixed an issue where a бот was failing in preprocessing mode
if the user had inserted and then disabled the Error Handler
> Catch action without also disabling the Finally or Catch
actions.

00629046 In the База данных пакет, when you use Microsoft Excel as a
database, the бот launcher now executes properly. Previously,
the бот launcher stopped working when reading data from an
Excel sheet that had some empty rows.
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Исправления в системе безопасности

ID обращения к облачному
сервису

Описание

00491697 The Transport Layer Security (TLS) protocol using CBC mode
of encryption for configuring the network security of the
Control Room is now secured from man-in-the-middle or
cyrstallographic timing attack.

Известные ограничения

When you add a form with the Dynamic element to a бот, click Add element, select Dropdown
or Radio group as the Type, and leave the Default value/ Default path field blank, the
elements appear as labels during бот runtime.

You can move a form around by dragging the title bar during бот runtime.

When you copy and paste the filepath for the Select file element of a form during бот runtime,
invalid characters are displayed.

When the Set focus action is assigned to a disabled form element, an error icon is displayed when
the focus is lost during бот runtime.

When you enable any of the disabled fields during бот runtime, error icons are not displayed.

Error messages during бот runtime are not displayed in the language selected in the Control Room.

If email trigger is used to start a бот, the status of the most recent email that you have viewed is
changed to Unread every time any бот is triggered based on the trigger interval set in the Check
every drop-down menu.

In an Control Room configured for Active Directory users, the following message appears after the
first admin user is created: Do you want to leave this page?
Обходное решение. Click Stay on page so that you can go to the Control Room login page.

If the device is already registered by a user other than the Bot Creator and the Bot Creator has
the Register device permission, then when you run a бот from the Bot editor window, the
deployment fails at the Connecting your computer to Enterprise Control Room step.

The migration process does not migrate manual dependency files added in the Enterprise 11
Control Room using the API. Боты associated with these dependencies will be migrated successfully
but will fail during execution because the system cannot find these dynamically added dependency
files at runtime in Enterprise A2019.

When a бот execution is in progress and the Control Room server refreshes, the progress status of
the In-Progress activity will not be displayed even though the бот execution continues without
interruption.

Discovery Bot

Introduction
Discovery Bot enables process automation by capturing document processes, identifying automation
opportunities from business processes, and prioritizing opportunities based on ROI. Users can convert
these opportunities into automated processes.
Process discovery by using Discovery Bot on page 2344
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Известные ограничения

Discovery Bot is not supported in high availability (HA) mode. When two Control Room instances
are used in a cluster configuration, the recording artifacts are split between the two Control Room
instances and the recording might fail to process.
Обходное решение. To enable Discovery Bot in HA mode, you must update the
processdiscovery.properties file to point to the repository path specified in the Control
Room:
1. From the Control Room, go to Administration > Settings > General.
2. Select the Control Room Database and Software tab.
3. Scroll to the Control Room Repository section.
4. Copy the path specified in the Repository path field.
5. Go to C:\Program Files\Automation Anywhere\Enterprise\config.
6. Open the processdiscovery.properties file.
7. In the processdiscovery.data.staging path, paste the repository path in

the <yournetworkshareddrive> here: \\<yournetworkshareddrive>\
\Processdiscovery\\staging\\data

8. Restart the Discovery Bot service.

When HTTP proxy is installed in a cloud environment, you can use the Discovery Bot recorder to
record processes.

Custom role setup for Discovery Bot is currently not supported.

The Discovery Bot recorder continues to record your steps even after you have logged out of the
Control Room.

Note:  Manually stop the recorder to end the recording session.

The Discovery Bot recorder displays an internal error message when accessing Google Apps. Pause
the recording and then resume the recording again to recapture the steps.

The recent recording (ID) created is displayed at the end of the list in the Recordings table. You
cannot sort on the recording ID at this time.

The recording count for a process is incremented by one even if a user stops or cancels a recording
session. The incremented number is displayed in the Recordings section in the tile for a process.

By default, you cannot move the endpoint in an upward direction in the path flow to change the
selection of the steps. You can move the branch endpoint lower in the path flow to include more
than one step.

You must add at least one step to a branch for you to select the branch and create an opportunity.

You must select all steps in a branch to create an opportunity. Selecting partial steps in a branch
will result in branch being dropped in the opportunity that is displayed from the Opportunities
tab.

Currently, the copy of field does not display the correct view information from the view (view ID)
that it is copied from.
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Известные ограничения

If the Control Room is not installed in the C:\ drive ( C:\Program Files\Automation
\Enterprise), the Discovery Bot installer fails to install correctly. If the Control Room is not
installed in the C:\ drive, then perform the instructions provided in this article:A2019.15 Discovery
Bot installation issue with non-OS drive (A-People login required).

The Export to Word option supports a maximum of 500 steps.

The Convert to Bot option supports a maximum of 500 steps.

Измененные функции

.

IQ Bot

Review the compatibility of the IQ Bot On-Premises version with the corresponding Control Room On-
Premises version.
Automation 360 IQ Bot version compatibility on page 745
For feature information about IQ Bot, see Матрица сравнения функций Automation 360 IQ Bot on page
740.
The IQ Bot Cloud version provides users with automatic provisioning for up to three environments such as
Development, Test, and Production.

Note:  IQ Bot Build 5931 is compatible with Enterprise A2019 Сборка 5933.

Новые функции

New IQ Bot Pre-processor пакет
On-Premises и Cloud
The following new actions are available as part of the IQ Bot пакет:
• Convert image to PDF
• Get barcodes
• Get document info
• Get page content

IQ Bot Pre-processor пакет on page 1661

Search by filename in Валидатор
On-Premises and Cloud (Service Cloud case ID: 00372981)
Use the Search by filename field in the Validator screen to search a document in IQ Bot.
IQ bot Validator enhancements
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Новые функции

IQ Bot [Local Device] пакет  (currently available on request only)
On-Premises и Cloud

Important:  Contact your Automation Anywhere representative to request the On-Premises пакет.
For Cloud, it is available as a pre-installed пакет.

Use the IQ Bot [Local Device] > Process documents action to process documents using
TaskBots created in the Control Room. You can scale by processing documents on multiple devices
simultaneously without setting up a separate IQ Bot cluster. You can set this up using workload
management in the Control Room.

Управление рабочей нагрузкой on page 2813
The validation is done using the current IQ Bot Валидатор and usage metrics on the dashboards,
which is available with the installed IQ Bot server.

Note:  You can create validators using interactive forms if they do not want to send data to the IQ
Bot server.

IQ Bot [Local Device] пакет on page 1659

IQ Bot Classifier пакет (currently available on request only)
On-Premises и Cloud
The IQ Bot Classifier пакет enables you to group documents into appropriate learning instances for
content extraction.
This пакет is not available as part of the standard IQ Bot installation.

Important:  Contact your Automation Anywhere representative to request the пакет.

IQ Bot Classifier пакет on page 1654

Migrate learning instances using Migration Utility
On-Premises и Cloud
Use the Migration Utility feature to migrate learning instances from one environment to another.
Additionally, you can back up, restore, download, delete, and upload learning instances.
Migrate learning instances on page 1362

Control creation of groups
On-Premises и Cloud
Use the New groups creation setting section in the Learning Instance > Edit page to limit
creating groups when uploading training documents to IQ Bot. Use the Threshold to create new
groups value and Never create new groups check box to define the parameters.
Bots
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Измененные функции

For the Custom Logic feature, the identified list of Python libraries now includes an additional set of
trusted libraries for IQ Bot On-Premises and Cloud. Go to Automation Anywhere support for a list of
the safe libraries you can use.
List of Pandas Libraries which are supported and not supported on Automation 360 IQ Bot (A-People login
required)

Исправленные функции

ID обращения к облачному
сервису

Описание

00376179 The Automation Anywhere Cognitive Project is now created
without any errors even when you use the IQ Bot batch files to
install or uninstall IQ Bot.

00560185 The Download Document in IQ Bot now runs without any
errors, irrespective of the language in which the learning
instances are saved.

00574815 You can now use the Google Vision API engine to classify the
selected PDF files without creating any unclassified groups.

-- Documents are now classified correctly by the Google Vision API,
irrespective of the display limitations set. Previously, an incorrect
resolution limitation created unclassified documents.

-- You can now use Internet Explorer to save a document or mark it
as invalid in the learning instances validator screen, without any
error messages.

00620237, 00623175 After logging in to the Control Room as an IQ Bot administrator,
the IQ Bot tab is no longer displayed in the navigation bar.

-- The Output.csv file generated for a validated document and
validated data are now displayed without any error messages.

00605607 When you click Save current document in the validator screen,
the document is saved without any errors and the corresponding
.csv file is created in the output folder.

-- IQ Bot deletes learning instances from Community Edition if they
have not had activity in 60 days.

Известные ограничения

IQ Bot On-Premises and Cloud
When you click the Save and go to next group option, the available groups or the learning
instances are sometimes not displayed.

IQ Bot On-Premises and Cloud
A validation error message along with the corrected field is displayed in the output (.csv) file for
documents validated using ValidatorURL.
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Известные ограничения

IQ Bot Cloud (Service Cloud Case ID: 00647700, 00657619, 00656643)
The output (.csv) files are not downloaded even when you click Download all documents
button, and an error message is displayed.
Contact Automation Anywhere support for more information.

Bot Insight

Новые функции

Date Interval option
Enterprise A2019
When you create new widgets that support date fields for a group or subgroup, the Date Interval
option is enabled with the default option set to Month.
Configuring a Line Bar Chart query on page 2993

New clustered line bar chart widget
Enterprise A2019 and Community Edition
The Clustered Line Bar Chart widget enables you to view and analyze information about your
metrics and attributes. You can provide two metrics and two attributes in your clustered line bar
chart. Now when two attributes are selected, a clustered graph grouped by primary and secondary
attributes is displayed.
Bot Insight visualizations on page 2992

New Device dashboard in the Operations dashboard
Enterprise A2019 and Community Edition
The Bot Insight Device dashboard displays various widgets that provide information about the
utilization of the machines on which the боты are executed. You can analyze the device utilization
and activity history of different Bot Runner machines.
Operations dashboard on page 2975

Исправленные функции

ID обращения к облачному сервису Описание

00540647 Dates are now displayed correctly on the
dashboard after the data is grouped based on
the date. Previously, incorrect dates were shown
on the dashboard.

Deprecated feature

The Widget Event Distribution by workbench is removed and will no longer be displayed in
the Audit Dashboard.
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Automation Anywhere Robotic Interface

Introduction
Automation Anywhere Robotic Interface (AARI) enables users to design a process workflow to address
their business requirements. The processes incorporate human and бот tasks using forms to define
parameters and render supported UI elements on the web. When using AARI on the web, users create
requests to use their created process workflow for process instances (case) and run their tasks.
AARI is available as a part of the Enterprise A2019 installer. You can view the AARI components in the
Administration page.
Configure roles for AARI on the web on page 2129

Important:  This AARI version has limited availability and is available only to sales and internal users.

Известные ограничения

When you edit a checked-out process that contains conditional steps with variables, you cannot edit
and save these conditional steps. The steps will revert any new variables you add.
Обходное решение. Delete and add a new condition.

The If, Else If, and Else actions cannot be placed before another бот logic in your workflow. You
can only place these actions at the end of the бот logic.
Обходное решение. Make a clear boundary on the conditional block.

In a process, when you use a date format such as 2020/07/04 in the input_date field in Bot
Task, the бот does not accept the date input.
Обходное решение. Create a separate date variable to use an input.

Form elements that are not supported and are deleted by the process editor include: Button,
Dynamic, Select File, and Snapshot.
Обходное решение. Instead of using the Button element, add a form action.

The Import bots and Export bots user interface labels do not match for a process but are still
applicable to importing or exporting a process.

When you access a public process, the Request display name field in Process entry is not
locked and can be edited. The existing variable in the field can be changed but not saved.

The Task display name option in Process entry has a field set to initialData that cannot be
edited in the process editor.

The Feed data into form table in the process editor does not allow editing.

The Element name field in the Bot Task and Human Task cannot contain spaces.

When you create two forms and assign the data of the first form to the second form using
$FormStep.input[]$, the second form data is not evaluated.

Redo functions are only available for canvas interactions. The redo functions are not available by
default until your first canvas interaction. The functions are available again when you interact with
your second canvas.

A team name that has a length of 20 characters or more is not accepted.
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Известные ограничения

Limitations in AARI on the web

Navigation bar When you open too many request tabs, the tabs
are hidden in the navigation bar.

Timestamp The timestamp of the closing step shows a
duplicate timestamp of the starting step in
request view.

Imported process When you export a process from an Control
Room and import that process as public to
another Control Room, the imported process
cannot be viewed.
Обходное решение. You can check in and
then check out the process, or import the
process as private and then do a check-in.

Configuration page In the device pool configuration page, the Bot
Runner users check box cannot be deselected.
Обходное решение. Double-click the check
box in the header.

Process management page A check-in process that is deleted from the
Control Room repository is still visible in the
process management page.

Form rendering • The Masked data option is not fully
supported for all elements. When this option
is added to hide data, the data is visible.

• The Checkbox and Radio Button elements
do not fully support horizontal format. When
these elements are configured to display
horizontally, the elements are displayed
vertically instead.

• The Document element is not fully
supported. When this element is configured
to a Default file path, the entire document
is not rendered.

• The Number element encounters issues
with large numbers. When this element is
configured to contain three number fields
and number values with trailing zeroes,
commas, and decimals, these values are
not honored and are not rendered. When
number values are entered in a number field,
such as a phone number box, the number
values are not accepted.

• The Text Box element encounters issues
with number-only input. When this element
is configured in a form to submit data, the
Submit option is not enabled when the field
contains only numbers.

• The Password element encounters
issues with maximum character limits.
The maximum limit is not enforced when
a password is entered in the initial form.
This element does not contain values when
submitted in the request tab.

• The Select File element does not support
the Open the doc in browser link. When
this link is open in the initial form, the link
redirects to the web main page.

• When a process is configured with two forms
that contain a Dropdown element, the
process creation shares the Dropdown
element data between the forms. However,
when you view the data in the request tab,
the Dropdown element in the second form
does not receive data from the first form.
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Enterprise A2019.14 Release Notes

Дата выпуска: 9 July 2020

Review the new features, supported packages, changed features, fixed features, and known limitations in
the Enterprise A2019.14 (Сборка 5322) release. There are no security fixes in this release.
• Enterprise A2019
• IQ Bot A2019
• Bot Insight A2019 on page 575

Enterprise A2019

To verify which  version is compatible with this release, see Compatibility with release builds on page 1033.

Новые функции

Migration from Enterprise 11 and Enterprise 10 to Enterprise A2019 (currently available
only to those in the Migration Early Adopter Program)
Enterprise A2019
Migration to Enterprise A2019 is currently only available to select customers through our Migration
Early Adopter Program. If you are interested in learning more about this program or a timeline
for when migration will be available to all customers, contact your Automation Anywhere
representative.
• Workload management data is automatically migrated to Enterprise A2019 when you install

Enterprise A2019 and point the Control Room to the restored Enterprise 11 database.
How workload management data is migrated on page 1209

• Version 11.3.1 and Version 11.3 are certified for migration to Enterprise A2019.

Миграция в Automation 360 on page 1133
• Additional support is provided for packages and variables.

Сопоставление пакетов для миграции on page 1258 | Сопоставление переменных для
миграции on page 1293

• Migrate TaskBots and MetaBots created in Enterprise 10 to Enterprise A2019 using APIs.
Migration API

Bypass legal disclaimer
Enterprise A2019
When you allocate a device license to a user, the Bypass legal disclaimer option is automatically
enabled to allow the user to run боты on the device without having to manually acknowledge a
disclaimer.
Create a user on page 2699
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Новые функции

Choose to automatically update Bot Agent (Service Cloud case ID: 00497873)
Enterprise A2019 and Community Edition
An Control Room administrator can now choose to automatically update the Bot Agent to a later
version (Administration > Devices) using the auto-update capability. In the earlier version, each
Bot Agent had to be updated manually after logging in to a device, resulting in more downtime.

Note:  In this release, Bot Agent users have to update each Bot Agent manually. From subsequent
releases, the auto-update setting will be applied and each Bot Agent will be updated automatically.

• For Cloud and Community Edition, the auto-update option is enabled by default.
• For On-Premises, the default update option is set to manual.

Автоматическое обновление Bot Agent on page 1049

Universal Recorder new features
Enterprise A2019 and Community Edition
• The Universal Recorder can now capture objects in SAP versions 730, 740, and 760 patch 5.
• You can build automations in an SAP application using multiple connections (user accounts) and

several sessions per connection at one time.
• You can now record and run боты to capture objects from a Google Chrome browser that does

not have a zoom level setting of 100%.

Capture active text, passive text, image button, and scroll in combo box in AISense
Recorder
Enterprise A2019
You can now capture active text, passive text, image button, and scroll in a combo box from a
remote application when recording a task with AISense Recorder.
Record a task with AISense Recorder on page 1980

New База данных пакет features (Service Cloud case ID: 00537047)
Enterprise A2019 and Community Edition
• The Connect action now enables you to connect to an Excel database.
• Use the Export to data table action to retrieve records from the database and store the

retrieved data in a table variable.
• You can now store the output of the Run stored procedure action in a dictionary variable.

Использование action «Подключить» для базы данных on page 1466 | Using the Export to data
table action on page 1476 | Using the Run stored procedure action on page 1472

New Active Directory пакет available
Enterprise A2019 and Community Edition
Use actions from the Active Directory пакет to manage users across a group or organization. You
can perform operations such as create, modify, and delete users, groups, or organizational units
with centralized control.
Active Directory пакет on page 1392
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Новые функции

Log in securely when connecting to Active Directory server
Enterprise A2019 and Community Edition
You can use the Connect action from the Active Directory to enter your credentials (username and
password). You can either insert the credentials from the Credential Vault or insert a variable that
holds a credential type value.
Using Connect action for Active Directory on page 1397 | Credentials and credential variables in the Bot
editor on page 2053 | Your variables (user-defined) on page 2040

Support for Excel cell formats, including Number, Percentage, Currency, Scientific, and
Date
Enterprise A2019 and Community Edition
Use the Get single cell and Get multiple cell actions from the Базовый Excel пакет and the For
each row in worksheet Цикл iterator to retrieve values in the format set in the Excel worksheet.
For example, a value from a cell of Currency formatting retains the currency symbol when passed
to a table or record variable.

Базовый Excel пакет on page 1540 | Цикл пакет on page 1695

Automate a task on a range of cells in an Excel worksheet
Enterprise A2019 and Community Edition
Specify a cell range in the Delete cells action to perform the operation on the cells in the range.
Excel advanced cell operations

New PDF пакет action
Enterprise A2019 and Community Edition
Merge multiple PDF files into a single PDF file using the Merge documents action.
Using the Merge documents action on page 1753

Support for Czech and United States 2 code pages in Эмулятор терминала пакет
Enterprise A2019 and Community Edition
The TN3270E and TN5250E terminal types support the Czech and United States 2 code pages. Use
the Connect action to select the terminal type and code page.
Using Connect action for Эмулятор терминала on page 1917

Proxy support for пакеты
Enterprise A2019
If a device is configured with a proxy, all outbound requests from the following пакеты are routed
through the proxy server:
• Средство записи
• Веб-служба REST
• Веб-служба SOAP
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Новые функции

Form builder enhancements
Enterprise A2019
The form builder now includes the following new elements:
• Dynamic - Enables dynamic rendering of the selected area.
• Snapshot - Enables you to take a snapshot of the form.

Enhancements to actions in Interactive forms
Enterprise A2019
• Enhanced highlight action

The Highlight action in the Interactive forms includes a Highlight type drop-down menu. You
can use Warning or Error to highlight the selected form element during the бот runtime.

• New Change label action
Use this action to change the label or title of the selected element of a specific form.

• Dynamic area action
• The Add row in Dynamic area action enables you to append or overwrite a dynamic

element of a form.
• The Clear action enables you to remove the dynamic elements.

Interactive forms пакет on page 1651

Retrieve trigger event data
Enterprise A2019
You can now retrieve the trigger event data during бот runtime by defining a variable as the input
type.
Add a file and folder trigger on page 2228

Record variable support for schema
Enterprise A2019 and Community Edition
You can create a new record variable with a schema to set the order of the fields and the type of
data that can be entered into each field.

Переменная записи on page 2049

Product interface now available in Russian language
Enterprise A2019
Enterprise A2019 is now available in Russian.

Интернационализация, локализация и поддержка языков on page 876
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Новые функции

Clone and view content in Control Room
Enterprise A2019
The Control Room now includes the following new permissions:
• View content: This permission allows you to view the contents of a cloned бот. This

permission applies to both public and private workspaces.
• Clone: This permission allows you to create a read-only copy of the бот from the public

workspace. The same бот can be cloned by multiple users. This permission applies only to the
public workspace.

Бот permissions for a role on page 2722

New condition in the Если and Цикл пакеты
Enterprise A2019 and Community Edition
Use the Dictionary > Check key condition to execute actions based on whether the value of the
specified key is Equal to or Not equal to, or Contains or Does not contain the target value.

Если пакет on page 1639 | Цикл пакет on page 1695

New encoding type in CSV/TXT and Записать в файл пакеты
Enterprise A2019 and Community Edition
The UTF-16LE encoding option provides support for files that contain the byte order mark (BOM)
Unicode character. In the CSV/TEXT > Open action, selecting this option causes the BOM
character to be ignored when data is retrieved from the file using a subsequent Read or Loop
action. In the Log to file action, this option inserts a BOM character at the beginning of the file.
Using the Open action for CSV/TXT file on page 1451 | Using Log to file action on page 1694

Retrieve a list of available users using Device API
Enterprise A2019
Use the Device API to identify all available users with unattended Bot Runner licenses, or to filter
for users by name. This API returns details of each user, including the user ID, username, and
device name.
Device API

Manually configure time interval value of database connection retries property (Service
Cloud case ID: 00573167)
Enterprise A2019 and Community Edition
You can manually configure the time interval value of the database connection retries in the
cluster.properties file. If the database is reconnected within the time specified in the
cluster.properties file, the Apache Ignite cache node in the cluster setup will not restart
the Apache Ignite server, keeping the device and the Control Room user connected. The default
value of the time property ignite.max.duration.db.connection.retries in the
cluster.properties file is 10000. The recommended maximum time for this property is up to 5
minutes (300000 msec).

Note:  Restart the Control Room services on each node for the manually configured value of the
time property to work effectively. Also, set the time in milliseconds.
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Новые функции

Run as user to default device mapping in Рабочая нагрузка automation (Service Cloud
case ID: 00563115)
Enterprise A2019 and Community Edition
Рабочая нагрузка automation now allows one-to-one (1:1) mapping of the Run As user with
default devices when these devices are part of a device pool. Therefore, you can select default
devices that are mapped to a Bot Runner to avoid auto-login failures in environments where the
security policy does not allow a user to log in to any other device or devices.
Add queue, Bot Runner, and device pool on page 2826

Authentication proxy support
Support is now available for proxy authentication servers where any application going through the
proxy is authenticated and authorized before accessing the internet.

Поддерживаемые пакеты

Пакет Версия

Node Manager 12.1.6000

Приложение 2.0.0-20200624-041608

Интеграция приложений 1.0.0-20200624-041607

Анализ 2.2.3-20200624-011702

Active Directory 2.0.1-20200624-041605

Логический 2.0.0-20200624-041610

Перенос ботов 2.4.0-20200604-174031

Браузер 2.0.0-20200624-041611

Буфер обмена 2.0.0-20200624-041619

Комментарий 2.0.0-20200624-041619

CSV/TXT 2.0.0-20200624-041620

База данных 2.0.0-20200624-041623

Таблица данных 2.0.0-20200624-042148

Дата/время 2.0.0-20200624-041628

Задержка 2.1.0-20200624-041629

Словарь 2.0.0-20200624-041629

Run DLL 2.0.0-20200630-062222

Эл. почта 2.0.0-20200624-041631

Обработчик ошибок 2.0.0-20200624-041636

Базовый Excel 2.0.0-20200630-062144

Расширенный Excel 4.0.0-20200630-062063

Файл 2.1.0-20200624-041638
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Поддерживаемые пакеты

Пакет Версия

File & folders 1.1.0-20200627-151822

Папка 2.1.0-20200624-041640

FTP / SFTP 2.0.0-20200624-041644

IF/ELSE 2.0.0-20200624-041646

Распознавание изображений 2.0.0-20200624-041747

Интерактивные формы 2.14.0-20200629-185534

IQ Bot 2.0.0-20200415-125005

JavaScript 2.0.0-20200630-062021

Имитация нажатия клавиш 2.0.0-20200624-041915

Legacy Automation 2.0.0-20200624-041919
1.0.0-20200515-133334

Список 2.0.0-20200624-041923

Записать в файл 2.0.0-20200624-041923

Цикл 2.0.0-20200624-041924

Message Box 2.0.0-20200624-041925

Мышь 2.0.0-20200624-041929

Число 2.0.0-20200624-041934

Распознавание текста (OCR) 2.1.0-20200630-062040

Office 365 Excel 2.0.0-20200630-062127

Календарь Office 365 2.0.0-20200630-061819

Office 365 OneDrive 2.0.0-20200630-062133

PDF 2.1.0-20200624-042032

PGP 2.1.0-20200630-062139

Ping 2.0.0-20200624-042035

Принтер 2.0.0-20200624-042042

Воспроизвести звук 2.0.0-20200624-042037

Запрос 2.0.0-20200624-042043

Python Script 2.0.0-20200624-042044

Средство записи 2.0.6-20200626-193519

Веб-служба REST 2.0.0-20200624-042128

SAP 2.1.0-20200624-042131

Экран 2.0.0-20200624-042134

SNMP 2.0.0-20200624-042137
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Поддерживаемые пакеты

Пакет Версия

Веб-служба SOAP 3.0.0-20200624-042140

Строка 3.0.0-20200624-042145

Система 2.0.0-20200624-042146

Задача 2.0.0-20200624-103759

Эмулятор терминала 3.2.0-20200625-032209

Trigger Email 1.1.0-20200624-042201

VBScript 2.0.0-20200630-062305

Ожидать 3.0.0-20200624-042156

Окно 2.0.0-20200624-042224

Рабочая нагрузка 2.0.0-20200624-042158

XML 2.0.0-20200624-042200

Измененные функции

Changes in the Database > Run stored procedure action
• It is now optional to enter an input or output parameter name.
• You must specify the data type of an input parameter. Choose from Boolean, date, number, or

string date type.

The terminal screen for ANSI and VT100 terminals now displays 24 rows, instead of 25 rows as in
earlier versions.

Email > Send action interface changes
For the Use secure connection (SSL/TLS) and My server requires authentication fields, you
must now select True or False, or insert a Boolean variable. Previously, the fields were activated
by selecting a check box.

Import боты in public or private workspace
Service Cloud case ID: 00456712
Users can now import боты into the public workspace if they have the required permissions,
regardless of their licenses. Additionally, users with a Bot Creator license can now import the боты
either into the public or private workspace.

Импорт боты on page 2852
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Исправленные функции

ID обращения к облачному
сервису

Описание

00554068 In the Community Edition, when you upgrade your Bot Agent
to a later compatible version, TaskBots created with system
variables of numeric type now run successfully. The Control
Room does not show a preprocessing error when you deploy the
TaskBots.

00443421 The Run stored procedure action in the База данных пакет
runs as expected with Oracle Database when you use input and
output parameters.

00557374 The Universal Recorder now consistently captures objects from
an SAP application and identifies the technology for those
objects as SAP when all prerequisites are met.

00611874 An error is no longer encountered when a variable containing
Japanese characters is used in the Write to file action of the
Таблица данных пакет.

00564534 A modified dependency file with the same name as the original
file and a new size is now successfully checked in from the
private to the public repository. The old file that was previously
checked in is no longer referenced after the modified file is
checked in to the public repository, thereby preventing a бот
execution failure.

00570537 When you clone a бот with or without dependency files, the
cloned бот now displays the actual file size for the бот and its
dependency files.

00577247, 00587976 Fixed an issue where the Email > Move all action did not
move emails when a бот ran the action on an OS configured
with the Japanese language setting.

00552729 The PGP > Decrypt action now works for PDF files.

00487805 You can now access the TN3270 terminal without the terminal
screen displaying all text with strike lines. Before using any type
of terminal to execute terminal commands, install the latest VC
++ package.
Latest supported Visual C++ downloads

00584051 Python 3 script now supports using Unicode characters in input
variables. Бот error messages are no longer displayed when
Python 3 is used to pass Japanese characters to a variable.

00540651, 00587963, 00593302 You can now use the Assign, Join, Merge, and Sort actions
from the Таблица данных пакет when you change the default
language from English to Simplified Chinese.
You can also use the Assign action when you change the
default language from English to Japanese, Korean, and other
non-English languages.

00577284 The Split document action in the PDF пакет now executes
correctly for a horizontal PDF file, and the large-width output file
is not cut off from the sides.
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Исправленные функции

ID обращения к облачному
сервису

Описание

00595357 You can now export and import two different боты (with the
same name) in different folders from a staging environment into
a production environment.

00569527 You can now perform a check-in and check-out of боты with
dependencies.

00574309 You can now update or remove Cluster ip addresses from the
Elastic search disaster recovery backup cluster setting
from the Control Room Administration page.

00525854 When a file type variable is used to open an Excel, CSV, or Java
script file, боты can now be executed successfully when the file
variable is used as an input.

00609184 After the existing license expires, the admin user can now
successfully install a new Control Room license for a Control
Room hosted on Linux CentOS.

00576202 You can now insert a user-defined string variable in a message
box display when the string variable is included in the
expression for multi-line values.

00560706 You can now view the actions menu (vertical ellipsis) to edit or
delete the variable string name when the character length is
more than 35 characters.

- For the Checkbox element, changes made to the check box
names in the Checkbox content field are now updated when
you enable Advance behaviors > Make default selections.

- You can now set the default selection in Advance behaviors
for the Radio button element in a form.

00557395 You can now check in боты that use the variable $prompt-
assignment$ without receiving an error message. Previously,
when you opened the бот in List view, an error icon was
displayed next to the actions that contain the variable.

00560356 Previously, when a task that consisted of one or more subtasks
was run, the In Progress entry for the task was moved into a
historical report with the completion of the first subtask, not the
entire governing task. Now, the In Progress tasks are not moved
to historical status until the completion of the entire task.

00556113 In Community Edition opened in Google Chrome, you can
now select the device icon in a non-English language, and the
[link] and [icon] tags are no longer displayed.

00559360 You can now re-import a бот that has failed previous imports.
The query did not return a unique result: 2
displayed during re-import attempts is now fixed.
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Исправленные функции

ID обращения к облачному
сервису

Описание

00443590 Fixed an issue where after a бот is deployed on a Bot Runner
device, that device is in a different state compared to the state
before the бот deployment. For example, if a Bot Runner device
is locked before бот deployment, after it is unlocked to deploy
the бот, it will now be moved back to lock status.

00559507, 00594149 Support for scheduling боты with Internet Explorer version 11
is now improved. Users in the Control Room can scroll through
multiple pages of scheduled боты without issues with scrolling
through the interface.

Известные ограничения

In Enterprise A2019 On-Premises, a security scan might report the Средство записи package as
malware because the check.exe file is missing the root identification certificate.
You can contact Automation Anywhere Support to get an updated package with the signature fix
and upload it to your Control Room.
Add пакеты to the Control Room on page 2664

Version Enterprise 10 or Enterprise 11 боты containing commands that have white space in the
credential attributes cannot be migrated to Enterprise A2019. The migration process stores some
credential attributes in global values in Enterprise A2019. Global values do not support white
spaces.
To migrate боты that use credential attributes, you can remove the white spaces or replace them
with characters.

If you use the Get action for an empty dynamic element of a form, errors are displayed during бот
runtime.

If you use Trigger loop: Handle within a бот, link it to a form with Select File element, and set
the Select action trigger > Lost focus, the next event is not triggered when you click Browse.

The Set focus action in Interactive forms does not work when you use it to link the fields
between two different forms.

In the form builder screen, text is displayed in English even when you change the display to non-
English language.

You might see the schedule automation name instead of the Рабочая нагрузка automation name
in the Workload > Queue > View Activity in progress and Run bot with queue > View
pages when Work Items are processed for automation in the Bot Agent. This occurs if the Рабочая
нагрузка automation ID and schedule automation ID are the same in the Control Room database.

The Task bot > Run action only supports files selected from the Control Room repository. Also,
this action only supports file type variables with a set default value and the input option disabled.
You cannot modify the file variable value using the File > Assign action.
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Известные ограничения

When you edit a бот using a previous package version (for example, an Enterprise A2019.13
version) and the Desktop session automatically starts, if you exit the Bot editor while the Desktop
session is trying to launch, the previous package version will be displayed when you open a
new Bot editor instance. However, you should see the Enterprise A2019.14 package version
associated with the new Bot editor instance. If you close and reopen the new Bot editor instance,
the Enterprise A2019.14 package version will be displayed.

There is an issue for a specific, manually generated license key file supplied by Automation
Anywhere to upgrade from Enterprise A2109.13 to Enterprise A2019.14.
This issue applies only to customers who are in the following specific category (all must be true):
1. Control Room is at the customer premises
2. Control Room is running Enterprise A2019.13 or earlier
3. Installed a license file that was provided to them in July 2020 (not self-generated through the

customer self-service license portal)
4. User has upgraded the On-Premises Control Room to Enterprise A2019.14.

For this issue, contact Automation Anywhere for updated license files.

Important:  Users who self-generated their license files through the A-People License portal are
not affected by this issue. Cloud customers are also not affected by this issue.

A бот that contains the Capture action from the Средство записи пакет fails when both the HTML
 InnerText and InnerHTML object properties are selected.
Обходное решение. Select only one of the object properties.

The Universal Recorder fails to perform a click, set text, or append text action on the correct control
when a debug window or download bar is open. This occurs only in the Google Chrome browser
with the device display set to 100%.
Обходное решение. Disable the Google Chrome download bar.

When you create, edit, or run a бот from the Bot editor window, close the Bot editor window when
the socket connection has just been established, and then navigate to the My bots page, the
Средство записи window opens for a moment and then closes.

Known limitation

IQ Bot

The IQ Bot A2019 On-Premises version supports all the features and functionality available in IQ Bot
Version 11.3.4.2.

Матрица сравнения функций Automation 360 IQ Bot on page 740
Review the compatibility of the IQ Bot On-Premises version with the corresponding Control Room On-
Premises version.
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Automation 360 IQ Bot version compatibility on page 745
The IQ Bot A2019 Cloud version is available for this release and supports all features and functionality
available in IQ Bot Version 11.3.4.2. This version provides users with automatic provisioning for up to three
environments such as Development, Test, and Production. Users can migrate learning instances between
environments using APIs.

Новые функции

Delete бот option in IQ Bot Designer (Service Cloud case ID: 00096258, 00595526)
IQ Bot On-Premises and Cloud
Users with Edit бот permission can view and use the Delete bot option in the Designer. After a
бот is deleted from the system, it will not be displayed in the Learning Instance or Bots listing
pages.
IQ Bot removes all document details from staging, and all unprocessed production documents are
moved to the Валидатор.

Note:  The Migration Utility > Import/Export functionality is not affected in any way by the
Delete бот feature.

Bots

Extract data from a table that spans across multiple pages (Service Cloud case ID:
00371795)
IQ Bot On-Premises and Cloud
IQ Bot can now extract data successfully from an entire table that spans across multiple pages and
has a table header only on the first page.

Add fields and field alias to custom domain (Service Cloud case ID: 00471075)
IQ Bot On-Premises and Cloud
You can now add additional fields (form or table) and field aliases to a custom domain for an
existing learning instance.

Alert for successful or pending document validations
IQ Bot On-Premises and Cloud
Document validation status is now displayed on the Learning instances page. A green icon is
used for all successful document validations, and a red icon shows any pending validations.

Измененные функции

Import custom domains from the staging to the production server in any order (Service
Cloud case ID 00472445)
You can now edit and update an existing custom domain multiple times and import them to the
production server multiple times, and in any order, before importing the learning instances. After
importing the learning instances, the system classifies all documents in the production server
correctly, allowing for successful processing of documents.
Custom domains in IQ Bot
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Измененные функции

Валидатор enhancements (Service Cloud case ID: 00470258)
Some of the Валидатор enhancements are as follows:
• You can now hide the Skip to next file and Mark as Invalid options using configuration

settings. The options are currently enabled by default.
To enable the option to hide them, contact Automation Anywhere Support.

• You can now hide the Hide successful fields and Hide optional fields options using
configuration settings. The options are enabled by default.
To enable the option to hide them, contact Automation Anywhere Support.

Note:  Selecting the Hide successful fields and Hide optional fields check boxes hides
all the valid fields and reduces the display of a large number of fields, thus making correction
easier. However, if there is an invalid field, it continues to be displayed because the invalid field
requires correction.

• Clicking in any column field expands the column width to accommodate the text entry. The
Валидатор shows the value of the field that is being validated, in the document.

• Draw an area around single or multiple values in the document image to automatically populate
a field in the Валидатор. This function is similar to the Designer.

Исправленные функции

ID обращения к облачному
сервису

Описание

00552830 You can now use the unique validation link to access the
documents without any errors.

- When you use table extraction from a document with multiple
tables, the data from the specified table is now extracted
correctly.

00551886 Unicode issue with table validation for Asian languages is now
resolved.

00538480 The Options method is now disabled for HTTP requests.

00538480 Cross origin resource sharing is now restricted in IQ Bot.

00421067 The activities time stamp is now captured correctly in the Control
Room Audit Logs tab.

00522817 The TestRun output of a custom logic now displays the
characters without any distortion, irrespective of the language
you select.

00605420, 00605741, 00606561 After upgrading to IQ Bot Cloud if you restart the Control Room,
you can now view or create learning instances immediately
without restarting the IQ Bot service.
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Известные ограничения

IQ Bot On-Premises and Cloud
If you create a learning instance and click Learning instances > Edit, a blank page is displayed.
Обходное решение. Clear your browser cache and try to edit the learning instances.

IQ Bot On-Premises and Cloud
If you log in to the Control Room as an IQ Bot administrator, a 502 system error is displayed
when you click the IQ Bot tab in the navigation bar.

IQ Bot On-Premises and Cloud
You can view the ValidatorURL error message for a validated document along with the corrected
field in the .csv output file.

IQ Bot On-Premises and Cloud
In Internet Explorer, you cannot save a document or mark it as invalid in the learning instances
validator screen.
Обходное решение. Use the Google Chrome browser to access the learning instances validator
screen.

IQ Bot Community Edition
If you remove a бот (Delete a bot) associated with the document from the staging environment,
you must create a group before uploading this document to the production environment. However,
after deleting the бот from the staging environment, you cannot create or edit the group when you
upload the same document to the production environment.

Bot Insight A2019

Новые функции

Line Bar Chart widget available
Enterprise A2019
The Line Bar Chart widget enables you to view and analyze information about your metrics and
attributes. You can input two metrics and one attribute and display a bar graph when only one
attribute is selected or display a clustered graph when two or more attributes are selected. You can
use Date types as interval options, grouped by Day, Week, Month, and Year.
Bot Insight visualizations on page 2992

Advanced settings for a query
Enterprise A2019
You can use the Advanced Settings option to configure more of your queries when you create a
new widget. You can now set limits to your attribute values as grouped by 10, 20, 50, and 100
values. You can also sort your data by ascending or descending order.
Configuring a Line Bar Chart query on page 2993
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Enterprise A2019.13 Release Notes

Дата выпуска: 15 июня 2020 года
Review the new features, supported packages, changed features, fixed features, and known limitations in
the Enterprise A2019.13 release. There are no security fixes in this release.
A2019.13 Сборка 4701 is available for Cloud customers, and Сборка 4705 is available for On-Premises
customers. Community Edition remains on A2019.12 and will be upgraded to A2019.14 upon availability.
• Enterprise A2019
• IQ Bot on page 584
• Bot Insight on page 587

Enterprise A2019

To verify which  version is compatible with this release, see Compatibility with release builds on page 1033.

Новые функции

Migration from Enterprise 11 and Enterprise 10 to Enterprise A2019 (currently available
only to those in the Migration Early Adopter Program)
Migration to Enterprise A2019 is currently only available to select customers through our Migration
Early Adopter Program. If you are interested in learning more about this program or a timeline
for when migration will be available to all customers, contact your Automation Anywhere
representative.
• The Insert work item command, workload management queues, and device pools are now

migrated to Enterprise A2019.
• Schedules are migrated when you copy Enterprise 10 data to Enterprise A2019 or update

Enterprise 11 data to Enterprise A2019. You then have to remap some dependencies to enable
the migrated schedules.

Включение расписаний после миграции on page 1254
• Additional support is provided for packages and variables.

Сопоставление пакетов для миграции on page 1258 | Сопоставление переменных для
миграции on page 1293

Record tasks with a device display setting of 125% or 150%
You can now record tasks using Universal Recorder in Java, Microsoft Active Accessibility, and
Microsoft UI automation applications on a computer that has a device display setting configured at
125% or 150%, in addition to the existing setting of 100%.

Export боты without enabling SMTP in Bot Lifecycle Management
When you export a бот, you can now download the exported package even when SMTP is not
enabled. The link to download the exported package is available in the ACTIVITY > Historical
page.

Экспортировать боты on page 2851
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Новые функции

Export and import files using Bot Lifecycle Management APIs
Use the Bot Lifecycle Management export and import APIs to move боты from one environment to
another based on your organization's automation requirements.
You can export боты with dependent files and command пакеты from the public workspace of one
Control Room and import them to a private workspace in another Control Room, and check them
into a public workspace. To export and import боты, you must have the Export боты, Import боты,
View and Manage packages, and Check in and Check out permissions to the necessary folders and
have the Bot Creator license.
BLM API

Capture scroll action and table using AISense Recorder
You can now capture the scroll action in an application window and table control from a remote
application when recording a task with AISense Recorder.
Record a task with AISense Recorder on page 1980

Form builder enhancements for interactive forms
The form builder includes the following elements:
• Select File: To enable file upload in the form.
• Выпадающее меню. To create a drop-down menu in the form.

Create a form on page 2202

Extract text from a specific area in a window
Use the App Integration > Capture area action to extract text from within the captured area of
a window and save it to a string variable.

Интеграция приложений пакет on page 1411

Read string variable values from a text file
Use the String > Import string from text file action to read values from a text file and save
them to a string variable.

Строка пакет on page 1895

Automate in IBM-5555 terminals using the Эмулятор терминала пакет
The TN5250E terminal type now supports the IBM-5555-C01 and D01 terminal models.
Terminal Emulator пакет on page 1916

Specify events within email trigger
For email triggers, specify an event within the server type (Outlook, Email, or EWS server) to
trigger a бот.
Add an email trigger on page 2224

Use hot key for interface trigger
For interface triggers, you can select hot key as one of the conditions to trigger the бот
Add an interface trigger on page 2230
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Новые функции

Assign action in interactive forms package
The interactive forms package now includes an Assign action that you can use to assign values
dynamically in the Dropdown element of a form.
Interactive forms пакет on page 1651

Create a shortcut of a file or folder
Use the Folder > Create shortcut or File > Create shortcut action to create a shortcut in the
specified destination file path. The shortcut is dependent on the source file or folder. If you make
changes to the source file or folder, the changes will also apply to the shortcut.

Файл пакет on page 1575 | Папка пакет on page 1584

New conditions in the Если and Цикл пакеты
• Use the Data table > Data table is empty condition to execute actions based on whether the

specified table contains values.
• Use the Data table > Number of columns and Data table > Number of rows conditions

to execute actions based on whether the number of columns or rows is Equal to, Greater
than, or Less than the specified value.

Если пакет on page 1639 | Цикл пакет on page 1695

Generate a random string of a user-specified number of characters and assign it to a
string variable
Use the String > Random action to generate a string of uppercase and lowercase alphanumeric
characters. You can specify the number of characters that the generated string consists of, with a
maximum of 300 characters.

Строка пакет on page 1895

Upgrading Enterprise A2019 enables pre-filling installation parameters
If you are upgrading from one Enterprise A2019 version to another, you have the option to pre-
fill the installation parameters with existing installation content. Existing installation parameters
include, for example, the installation path, HTTPS ports, database names, IP addresses, and TLS
configuration. The username and password have to be manually entered.
Note that this is applicable only to a Windows-based installation.
Run Control Room installer on page 910 | Installing Control Room on Linux on page 953

Поддерживаемые пакеты

Пакет Версия

Node Manager 7.1.5207

Приложение 2.0.0-20200515-071407

Интеграция приложений 1.0.0-20200515-071406

Анализ 2.2.2-20200515-101604

Логический 2.0.0-20200515-071408

Перенос ботов 2.4.0-20200604-174031
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Поддерживаемые пакеты

Пакет Версия

Браузер 2.0.0-20200515-071410

Буфер обмена 2.0.0-20200515-071418

Комментарий 2.0.0-20200515-071418

CSV/TXT 2.0.0-20200515-071419

База данных 2.0.0-20200515-071421

Таблица данных 2.0.0-20200515-071731

Дата/время 2.0.0-20200515-071424

Задержка 2.1.0-20200515-071425

Словарь 2.0.0-20200418-005349

Run DLL 2.0.0-20200515-071713

Эл. почта 2.0.0-20200515-071427

Обработчик ошибок 2.0.0-20200515-071432

Базовый Excel 2.0.0-20200515-071623

Расширенный Excel 4.0.0-20200604-173722

Файл 2.1.0-20200515-071434

File & folders 2.0.0-20200317-030352

Папка 2.1.0-20200515-071436

FTP / SFTP 2.0.0-20200515-071439

IF/ELSE 2.0.0-20200515-071441

Распознавание изображений 2.0.0-20200515-071454

Интерактивные формы 2.12.0-20200420-084203

IQ Bot 2.0.0-20191031-150538

JavaScript 2.0.0-20200515-071459

Имитация нажатия клавиш 2.0.0-20200515-071502

Legacy Automation 2.0.0-20200515-133330
1.0.0-20200515-133334

Список 2.0.0-20200515-071509

Записать в файл 2.0.0-20200515-071509

Цикл 2.0.0-20200515-071511

Message Box 2.0.0-20200515-071511

Мышь 2.0.0-20200515-071517

Число 2.0.0-20200515-071522

Распознавание текста (OCR) 2.1.0-20200516-083309
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Поддерживаемые пакеты

Пакет Версия

Office 365 Excel 2.0.0-20200515-071608

Календарь Office 365 2.0.0-20200515-071414

Office 365 OneDrive 2.0.0-20200515-071614

PDF 2.1.0-20200515-071618

PGP 2.1.0-20200515-071620

Ping 2.0.0-20200515-071621

Принтер 2.0.0-20200515-071626

Воспроизвести звук 2.0.0-20200515-071622

Запрос 2.0.0-20200515-071627

Python Script 2.0.0-20200515-071628

Средство записи 2.0.5-20200523-020302

Веб-служба REST 2.0.0-20200515-071712

SAP 2.1.0-20200515-071715

Экран 2.0.0-20200515-071718

SNMP 2.0.0-20200515-071720

Веб-служба SOAP 3.0.0-20200515-071723

Строка 3.0.0-20200515-071729

Система 2.0.0-20200515-071729

Задача 2.0.0-20200519-082744

Эмулятор терминала 2.0.0-20200515-071735

Trigger Email 1.1.0-20200515-022805

VBScript 2.0.0-20200515-071737

Ожидать 3.0.0-20200515-071739

Окно 2.0.0-20200515-071753

Рабочая нагрузка 2.0.0-20200422-054201

XML 2.0.0-20200515-071743

Измененные функции

The Dictionary > Put action is now the Dictionary > Set value action. When you provide the
key name, if the key does not already exist, this action creates a new key-value pair. In addition,
you can now manually enter a value; previously, you had to select from a list of variables.

In the Excel advanced > Get worksheet as data table action, the Tick if the first row is the
header option is now the Sheet contains header option. There is no change in functionality.
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Измененные функции

The File > Rename and Folder > Rename actions now accept the full file path in the New file
name and New folder name fields. Previously, these fields only accepted the new file or folder
name.

When you select a file from the desktop for the JavaScript, Python Script, or VBScript пакеты, it is
no longer necessary to isolate that file in a separate folder. Previously, when you selected a file with
the Open action, all the files in that folder were selected too.

The Database > Run stored procedure action now has a different interface that enables you
to configure input parameter values and output parameter data types. This action is not backward-
compatible because the user interface controls and input data type have changed. You must modify
the Run stored procedure action fields in the боты that contain previous versions of this action.

The Cloud License feature is now enabled by default in the Control Room.

Исправленные функции

ID обращения к облачному
сервису

Описание

00492377, 00511639 Боты using the Image Recognition action can now recreate the
recorded activity and run successfully.

00599586, 00600149, 00601142,
00599483

The Processing failure error encountered when using the
Wait for condition action is now fixed. Боты using this action
now run successfully.

00583248 During Work Item consumption, a running task is no longer
canceled when the next бот is deployed.

00548456 The Workload Management v3 APIs are now successfully
executed in Swagger and do not fail because of a case-sensitive
issue.

00601083 For Cloud deployment, users can now successfully export бот
files and download them without any errors.

00568664 The Git integration option is now displayed for admin users
when they navigate to ADMINISTRATION > Settings in the
Control Room.

-- The minimum length value of a form element cannot be 0. If
you set the value as 0 in Character limit > Min field, the
Make field required is disabled.

00571125 When you check in a non-bot file by itself, the file is now
checked in without any error. Older files that exist in Сборка
4111 are also unlocked and checked in after upgrading to
Сборка 4705.

-- The form preview feature is now consistent across the Internet
Explorer and Google Chrome browsers.

-- A blank page is no longer displayed when you paste content
into any of the existing form elements on the form builder.
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Исправленные функции

ID обращения к облачному
сервису

Описание

-- A form that is linked to a бот through the Display action of
interactive forms is now displayed in front of all other windows
when the Always display form window in front option is
selected.

-- When a user login failed due to a Global Catalog (GC)
availability issue, the response only indicated a communication
error. The process now checks for errors and exceptions in
the GC and processes the authentication with appropriate
messages, so users can take appropriate action.

00520394 The VBScript пакет actions now support Unicode characters.

00536881 When you delete a бот, any trigger that is associated with it is
also deleted and is not listed in the Activity list page.

00506169 You can now use the interface trigger to run a бот without any
errors in the Japanese operating system.

00537640, 00538369 When you check out a бот from the Control Room and add a
trigger, you can now use Run with triggers to run this бот
without any errors.

00531912 JavaScript пакет actions can now be used to parse the values in
a list.

00475183 Double-byte characters returned unreadable ANSI characters
in the бот Log To File text. This issue is now fixed and ANSI
encoding takes the system default charset.

00475129 You can now use double-byte characters in a variable name.

00511675 The Excel advanced > Find action now searches for values in
merged cells when the By rows search option is used.

00468103, 00475142 Бот names using Unicode characters, such as German umlaut,
Japanese characters, and others, display correctly in the pop-up
window at runtime.

00552701, 00558919 You can now select multiple actions from the Bot editor and
drag them into a Step, Loop, or If action.

00507240 Fixed an issue where a running parent бот could not be stopped
after it ran a child бот. Now you can stop a бот at any time.

00482810 VBScript actions can now run scripts that contain Unicode
characters.

00472684, 00541922,
00551632,00534508, 00570602

The Email > Send action now supports a user-input port
number for sending emails from an SMTP server, such as AWS
Simple Email Service. Previously, the action only used port 25,
even if the user entered a different port number.

00475230 Fixed an issue where the String > Replace action did not
support an empty string in the Replace with field. You can
now use the action to replace a specific string with an empty
string.
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Исправленные функции

ID обращения к облачному
сервису

Описание

00472665 When a child бот shows an error, the parent бот now handles
the exception by running the Error Handler > Catch action.
Previously, the parent бот was also showing an error, even
when it contained Обработчик ошибок actions.

00566476, 00560339 Fixed an issue where боты that contain the Capture action
stopped working when running the action during deployment,
or they could not be checked out after they were checked-in for
editing.

00537139 A бот running the Capture action can now capture specific
objects from a Google Chrome browser on a device running the
Windows 10 operating system. In some cases, боты running
the Capture action from Version A2019.11 On-Premises could
only capture the entire browser window.

00421864 The Create a bot screen now displays properly in Internet
Explorer. Previously, some display issues occurred where the
screen was cut on the right side and the screen could not be
moved.

00584341 Fixed an issue where some of the historical activity entries were
incorrectly displayed. These entries are now displayed correctly
when a user drills down for more information.

Известные ограничения

When you create a Dictionary/Table variable and use it in the name field of the PROPERTIES
control, the бот does not deploy successfully. This issue occurs because Dictionary/Table variables
are not supported for the name field in the PROPERTIES control. You can pull the name value into
a String or Number variable before using it in the PROPEPTIES control, and then use that String or
Number variable in it.

You can use Swagger to export боты but not to download exported боты. You have to use the
REST Client to download exported боты.

When you run a бот, the runtime window is minimized after you preset the desktop.

The OSS Disclosure report provided in the A2019 installer is outdated. Starting from this release,
you can log in to Automation Anywhere Support site and download the updated report:
A-People Downloads page (Login required).

When you capture a table control from an application using the AISense Recorder, you cannot set
text using the Set text option from the Actions list. You can set text in the table by capturing a
cell from the table as a text box and then using the Set text option from the Actions list.

When upgrading from one Enterprise A2019 version to another, you have the option to pre-fill the
installation parameters with existing installation content, but only if you used the default installation
path C:\Program Files.

Note:  This is applicable only to a Windows-based installation.

© 2023 Automation Anywhere. All rights reserved.     583

https://apeople.automationanywhere.com/s/downloads


    Automation Anywhere - Learn

Известные ограничения

Based on the permission assigned by an administrator, users can only view the Public tab that lists
the available forms and боты. However, users can edit an available form or бот by replacing View
with Edit in the Control Room URL.

When you create a бот and link a form to it, the бот is included only when you check in the form; it
is not available on form check-out.

When you click multiple icons (Copy, Cut, and Paste) at the top of the form builder or бот creator
page, the tooltips overlap.

Issues in the form builder:
• If you drag any form element into a specific position on the form builder, it always appears at

the bottom of the available elements.
• If you drag form elements around in the form builder screen in Internet Explorer, the mouse

pointer flickers continuously.
• For the Radio button element, you cannot set the default selection in Advance behaviors.
• For the Checkbox element, changes made to the check box names in the Checkbox content

field are not updated when you enable Advance behaviors > Make default selections.

When a бот runs Эмулятор терминала пакет actions in an IBM-5555 terminal, the terminal
window does not display double-byte characters, including Chinese and Japanese characters.

If you used the Universal Recorder to capture a menu item from a Microsoft Active Accessibility
application on a computer that has a display scale setting configured to 100%, at runtime the бот
does not click the correct menu item on a computer that has a display scale setting configured to
125% or 150%.

During GUID provisioning, License Sync is called internally after a successful installation. If the
internal License Sync fails but the installation is successful, users can log in and continue to work.

When a task that consists of one or more subtasks is run, the In Progress entry for the task is
placed into a historical report upon completion of the first subtask, not the entire governing task.

An error occurs if the parent бот contains actions for objects captured using the AISense Recorder
and the child бот contains actions for objects captured using the Universal Recorder, or vice versa.

IQ Bot

The IQ Bot On-Premises version supports all the features and functionality available in IQ Bot Version
11.3.4.2.

Матрица сравнения функций Automation 360 IQ Bot on page 740
Review the compatibility of the IQ Bot On-Premises version with the corresponding Control Room On-
Premises version.
Automation 360 IQ Bot version compatibility on page 745
The IQ Bot Cloud version is available for this release and supports all features and functionality available
in IQ Bot Version 11.3.4.2. This version provides users with automatic provisioning for up to three
environments such as Development, Test, and Production. Users can migrate learning instances between
environments using APIs.
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For the Custom Logic feature, there is an identified list of Python libraries and packages that are safe
to use for IQ Bot Cloud. Use only these packages to ensure security for your cloud infrastructure, file
systems, databases, and network resources.
List of Pandas Libraries which are supported and not supported on Automation 360 IQ Bot (A-People login required)

Новые функции

Migrate data to a unified database
IQ Bot On-Premises and Cloud
The Database Migration Assistant enables you to migrate data from IQ Bot Version 6.5 or later
databases to a unified database in IQ Bot A2019.
Migrate earlier IQ Bot versions to Automation 360 IQ Bot On-Premises on page 1358

Support for custom validation Python scripts
IQ Bot Cloud
You can use custom logic in Python to modify intermediate extracted data in IQ Bot.
Add custom logic in IQ Bot to improve extraction

Select an Распознавание текста (OCR) engine when creating a learning instance
IQ Bot On-Premises and Cloud
You can select different Распознавание текста (OCR) engines directly from the UI based on your
requirements for data extraction from specific document types, when creating a new learning
instance. You do not have to stop and restart IQ Bot services for implementing the engine change.
Select an OCR engine

Enable or disable PDFBox option
IQ Bot On-Premises and Cloud
You can enable or disable the My PDF documents do not have images check box directly in the
UI when creating a learning instance.
Disable PDFBox option

Changed feature

The draw box icon for document values is no longer available. However, you can still click and drag
a box on the document to draw boxes for the labels along with the values.

Исправленные функции

ID обращения к облачному
сервису

Описание

-- A new REST API is now available that contains the IQ Bot
validator URLs of all the available documents that are not locked
by any users. A validator URL retrieved from the REST API can
be used in any browser to navigate directly to that specific
document.

00343034 You are now redirected to a specific document using the validator
URL after a successful login.
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Исправленные функции

ID обращения к облачному
сервису

Описание

00471068, 00339407 The draw box functionality for field labels now ensures that the
selected value is treated as an entire word rather than distinct
characters. You can now select multiple system identified regions
(SIRs) or a specific part of a single SIR from a field label, which
enables accurate data extraction.

-- The PDF Box feature now enables you to generate an SIR for a
PDF file that contains content in multiple formats.

00481720 The Service account user password can now include special
characters. The service account will not be locked and all the
IQ Bot services will start successfully after an installation,
irrespective of whether the password has special characters.

00510286, 00548393 When the Automation Anywhere Cognitive Application service
restarts after installing IQ Bot Сборка 4705, the user login
information is now captured without any duplication.
However, if you upgrade from any earlier version of IQ Bot to IQ
Bot A2019.13 (Сборка 4705), you must deregister and register
IQ Bot services.

00522978 When you now install IQ Bot, the user account is not locked even
when the password has special characters, and all the IQ Bot
services start without any issues.

00581425, 00581949,
00604394, 00602630

You can now register IQ Bot with child tenant using API, which
enables you to view all the available domains and learning
instances.

00575939, 00417631, 00423076 The .csv file is now displayed in the Output folder when
you upload a document with a long filename (more than 60
characters) using IQ Bot Upload.

Известные ограничения

IQ Bot On-Premises
The OSS Disclosure report provided in the IQ Bot A2019 installer is outdated. Starting from this
release, you can go to Automation Anywhere support site to download the updated report:
A-People Downloads page (Login required).

IQ Bot On-Premises and Cloud
Images on the Designer in IQ Bot appear distorted while scrolling in Internet Explorer.

IQ Bot On-Premises and Cloud
Installation errors are displayed for the Database Migration Assistant.
Обходное решение. Install the MsSqlCmdLnUtils utility and Microsoft OCDB Driver 17
for Сервер SQL before installing the Database Migration Assistant.

IQ Bot On-Premises and Cloud
Logs are not captured if the Database Migration Assistant installation fails.
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Известные ограничения

IQ Bot Cloud
System suggestions are not updated when documents are validated by the user.
Обходное решение. Users must update the correction manually in the validator for IQ Bot Cloud
if the system suggestions are not displayed.

IQ Bot Community Edition
The Create new learning instance page refreshes automatically, which causes the user to lose
data from the General information fields.

(ID обращения к облачному сервису: 00737991)
When you are creating a learning instance and training your document, IQ Bot system cannot
extract data from tables with the same Header Name and Column Value.
Обходное решение. Try combining Header Name or Column Value with the adjacent
column. Additionally, you can provide a Python postprocessing script to separate the values during
extraction.

Bot Insight

Новые функции

Compare mode widget filter
The Bot Insight compare mode introduces widget filters that you can apply to your existing
dashboards. A new Filter option shows a Filter window with the Attributes, Numeric, and Time
widgets.
Comparing dashboards on page 2984

Hourly support for widgets
The Bot Insight widgets include an Hour interval option in the Group By field for Date type. The
analytics for this widget groups your data by hourly intervals and displays the chart accordingly.
Using widgets on page 2990

Измененные функции

Power BI connector
You can access the AABotInsightV3.mez data connector file from C:\Program Files
\Automation Anywhere\Enterprise\Connectors\PowerBI and copy it to C:\Users
\<your user>\Documents\PowerBI Desktop\Custom Connectors to deploy the Power BI
connector.
Deploy Power BI connector on page 2996
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Измененные функции

Bot Insight APIs
• All of the parameters are now optional.
• The botname parameter in the Get task log data API supports multiple бот names,

separated with a comma.
• There are no time period limitations now on the data retrieved.

Bot Insight API

Enterprise A2019.12 Release Notes

Дата выпуска: 18 May 2020

Review the new features, supported packages, changed features, fixed features, and known limitations in
the Enterprise A2019.12 (Сборка 4111) release. IQ Bot Build 4088 is compatible with Enterprise A2019.12
Сборка 4111. There are no security fixes in this release.
• Enterprise A2019
• IQ Bot A2019
• Bot Insight A2019

Enterprise A2019

Important:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.

Автоматическое обновление Bot Agent on page 1049 | Обновление Bot Agent вручную on page 1050

To verify which  version is compatible with this release, see Compatibility with release builds on page 1033.
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Новые функции

Migration from Enterprise 11 and Enterprise 10 TaskBots and MetaBots to Enterprise
A2019 (currently available only to those in the Migration Early Adopter Program)
Enterprise A2019
Migration to Enterprise A2019 is currently only available to select customers through our
Migration Early Adopter Program. If you are interested in learning more about this program and
requirements, contact your Automation Anywhere representative.
• Migrate TaskBots and MetaBots created in Enterprise 10 to Enterprise A2019.

Миграция корпоративных боты on page 1227
• The summary report generated by the Bot Scanner now provides information about the number

of боты that can or cannot be migrated to Enterprise A2019.

Анализ отчета Bot Scanner для миграции on page 1171
• (Enterprise 11 only) Additional support is provided for packages and variables.

Сопоставление пакетов для миграции on page 1258 | Сопоставление переменных для
миграции on page 1293

• (Enterprise 11 only) Migration APIs enable you to migrate a single Enterprise 11 бот or entire
folders of боты to Enterprise A2019. Use the Repository Management API to identify боты and
folders for migration.
Migration API | Repository Management API

Integrate Control Room with a remote Git repository
Enterprise A2019
Integrate the Control Room with remote Git repositories to manage бот version controls, and back
up and restore боты and the dependent files. The integration ensures one-to-one mapping of боты
between the Control Room and the remote Git file structure. When you perform a бот check-in, a
Git commit is performed at the remote Git host.
Integrating Control Room with Git repositories on page 2770

Additional actions in the Interactive forms package
Enterprise A2019 and Community Edition
The Interactive forms package includes the following actions:
• Set focus: Sets the focus on the selected form element.
• Highlight: Highlights the selected element of a form.
• Unhighlight: Removes the highlight from the selected element of a form.

Interactive forms пакет on page 1651

Form builder enhancements for interactive forms
Enterprise A2019 and Community Edition
The form builder includes the following elements:
• Document: Use this element to render an image (.jpg) or PDF file along with the form.
• Пароль. Use this element for a field that requires masking of the input data.

Create a form on page 2202
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Новые функции

Run Task Bot option for attended Bot Runner (Service Cloud case ID: 00453797)
Enterprise A2019 and Community Edition
If the default device is mapped to the Bot Agent, a user with an attended Bot Runner license in the
Control Room can now use the Run Task Bot option from the бот context menu (vertical ellipsis)
to run the бот.
Considerations for running a бот on page 2008

New features in Universal Recorder and actions that use the recorder feature
Enterprise A2019 and Community Edition
• В режиме безопасной записи конфиденциальные данные не сохраняются в боты. When

secure recording mode is enabled, the боты do not capture application images or values.
Действия in the Распознавание изображений, Мышь, Распознавание текста (OCR), Экран,
and Средство записи пакеты support this feature.

• JRE 6 is supported on both 32-bit and 64-bit systems.
• After you capture an object, you are returned to the window containing the Bot editor.

Действия in the Распознавание изображений, Мышь, Распознавание текста (OCR), Экран,
and Средство записи пакеты support this feature.

Recording tasks in applications that run on JRE on page 1978 | Secure recording mode on page 1977

Insert a work item action
Enterprise A2019 and Community Edition
The Insert work item action provides you the flexibility to insert a work item from an existing queue
to another queue as part of the бот execution. You can orchestrate multiple боты, enabling optimal
device utilization through the queueing mechanism of workload management.

Рабочая нагрузка пакет on page 1951

View error details of a work item
Enterprise A2019 and Community Edition
You can view the reason for a workload automation failure in the new Error section on the View
work item details page.
View work items on page 2841

Extract text from windows
Enterprise A2019 and Community Edition
Use the Capture text of window action to extract text from a window and save it to a string
variable. You can capture text from UNIX shells and Windows applications.

Интеграция приложений пакет on page 1411

Store string values securely in a credential variable
Enterprise A2019 and Community Edition
Configure a credential variable to hold a user-provided value or a credential from the Credential
Vault. A credential variable cannot be converted to another data type, and the value cannot be
displayed in a message box or written to a file.
User-defined variables: Credential
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Новые функции

Preload packages for improved бот performance
Enterprise A2019 and Community Edition
Preload packages on your local device to shorten the бот runtime. When you preload packages
used in a бот, the system skips the package download process at бот runtime, thereby improving
the бот performance.
Preload пакеты on page 2017

New features in the Если and Цикл пакеты
Enterprise A2019 and Community Edition
• Execute actions based on whether the value of the source datetime variable is Equal to or Not

Equal to, or is Greater than or Equal to, or is Lesser than or Equal to the value of the
target datetime variable.

• Execute actions on migrated боты based on whether Web control exists or is active.
• Configure a Loop action with multiple conditions.

Specify whether all or either of the conditions must be met.

Если пакет on page 1639 | Цикл пакет on page 1695

Run a бот by inserting a file variable in the Run action
Enterprise A2019 and Community Edition
The Task Bot > Run action now supports a file variable input in the Task Bot to run field.

Configure a table variable using the Assign action in Таблица данных пакет
Enterprise A2019 and Community Edition
You can use this action to manually enter values, assign column names, specify the column data
type (string, number, datetime, or Boolean), and move columns and rows.

Таблица данных пакет on page 1453

Configure Ожидать пакет actions to terminate a running бот if a condition is
unsatisfied
Enterprise A2019 and Community Edition
Select the Throw an exception option in the Wait for screen change and Wait for window actions
to show an error message and terminate a бот if the screen does not change or the window does
not open or close within the specified amount of time.
Using Wait for screen change action on page 1938 | Using Wait for window action on page 1941

Email trigger for new emails
Enterprise A2019 and Community Edition
Use email triggers to start a бот when a new email message is received in the specified email
service. Supported email services are:
• Microsoft Outlook
• Email Server
• Сервер EWS

Add an email trigger on page 2224
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Новые функции

Generate a random integer from a user-specified range and assign it to a number
variable
Enterprise A2019 and Community Edition
Use the Random action from the Число пакет to generate an integer in the range of
-9,223,372,036,854,775,808 through 9,223,372,036,854,775,807.
Random number action

Enterprise A2019 Bot Agent OS support
Enterprise A2019
Enterprise A2019 Bot Agent is now supported for single users on Windows Server 2019, Windows
Server 2016, Windows Server 2012, Windows 8, and Windows 7 SP1.

Совместимость Bot Agent on page 1032

Return the Bot Agent installation path using the system variable AAInstallationPath
Enterprise A2019 and Community Edition

Copy and paste actions and triggers between боты (Service Cloud case ID: 00455116)
Enterprise A2019 and Community Edition
Use the Copy to shared clipboard and Paste from shared clipboard icons at the top of the
Bot editor to duplicate actions, triggers, and metadata at a time.

GDPR self-reporting
Enterprise A2019 and Community Edition
General Data Protection Regulation self-reporting enables the Control Room administrator to run
reports that include the following data elements (sensitive data will be masked in the output):
• User Bot Runner device access.
• User data in associated credential vault.
• Devices registered by the user.
• All documents (artifacts) uploaded or updated to public or private repositories by the user.
• All боты associated to the user.
• Bot Insight dashboard report includes a list of all dashboards associated to this user ID.

Поддерживаемые пакеты

Пакет Версия

Node Manager 6.5.4738

Приложение 2.0.0-20200418-005328

Интеграция приложений 1.0.0-20200418-005326

Анализ 2.2.1-20200314-193039

Логический 2.0.0-20200418-005329

Перенос ботов 2.3.0-20200424-015945

Браузер 2.0.0-20200418-005330
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Поддерживаемые пакеты

Пакет Версия

Буфер обмена 2.0.0-20200418-005342

Комментарий 2.0.0-20200418-005342

CSV/TXT 2.0.0-20200418-005342

База данных 2.0.0-20200418-005345

Таблица данных 2.0.0-20200418-005637

Дата/время 2.0.0-20200418-005348

Задержка 2.1.0-20200418-005348

Словарь 2.0.0-20200418-005349

Run DLL 2.0.0-20200418-005620

Эл. почта 2.0.0-20200418-005352

Обработчик ошибок 2.0.0-20200418-005357

Базовый Excel 2.0.0-20200422-000204

Расширенный Excel 2.0.0-20200422-000103

Файл 2.0.0-20200418-005358

File & folders 2.0.0-20200317-030352

Папка 2.0.0-20200418-005400

FTP / SFTP 2.0.0-20200418-005404

IF/ELSE 2.0.0-20200418-005406

Распознавание изображений 2.0.0-20200420-104210

Интерактивные формы 2.12.0-20200420-084203

IQ Bot 2.0.0-20191031-150538

JavaScript 2.0.0-20200418-005413

Имитация нажатия клавиш 2.0.0-20200418-005415

Legacy Automation 1.0.0-20200422-075546
1.0.0-20200422-075549

Список 2.0.0-20200418-005422

Записать в файл 2.0.0-20200418-005423

Цикл 2.0.0-20200418-005424

Message Box 2.0.0-20200418-005424

Мышь 2.0.0-20200418-005428

Число 2.0.0-20200418-005433

Распознавание текста (OCR) 2.1.0-20200418-005434

Office 365 Excel 2.0.0-20200418-005517
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Поддерживаемые пакеты

Пакет Версия

Календарь Office 365 2.0.0-20200418-005338

Office 365 OneDrive 2.0.0-20200418-005523

PDF 2.1.0-20200418-005526

PGP 2.1.0-20200418-005528

Ping 2.0.0-20200418-005529

Принтер 2.0.0-20200418-005535

Воспроизвести звук 2.0.0-20200418-005530

Запрос 2.0.0-20200418-005536

Python Script 2.0.0-20200418-005537

Средство записи 2.0.0-20200318-020414

Веб-служба REST 2.0.0-20200418-005619

SAP 2.1.0-20200418-005622

Экран 2.0.0-20200418-005625

SNMP 2.0.0-20200418-005627

Веб-служба SOAP 3.0.0-20200418-005630

Строка 3.0.0-20200418-005635

Система 2.0.0-20200418-005636

Задача 2.0.0-20200417,230104-1256

Эмулятор терминала 2.0.0-20200418-005641

Trigger Email 1.1.0-20200418-005652

VBScript 2.0.0-20200418-005643

Ожидать 3.0.0-20200418-005645

Окно 2.0.0-20200418-005700

Рабочая нагрузка 2.0.0-20200422-054201

XML 2.0.0-20200418-005650

Измененные функции

Build 4105 replaced with Сборка 4111
Build 4105 has been deprecated and replaced with Сборка 4111. If you have installed Build 4105
on Windows, perform a regular upgrade to get the new build. If you have installed Build 4105 on
Linux, you must uninstall it and reinstall Сборка 4111. After you are on Сборка 4111, an update to
Bot Agent 7.0.4789 is also required.

Обновление до последней версии Automation 360 on page 1070
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Измененные функции

User interface changes in Базовый Excel and Расширенный Excel пакеты
The text field titled Cell name is now Cell address in the actions from the Базовый Excel and
Расширенный Excel пакеты.

Specify the column title in the Get cell address action in the Расширенный Excel пакет
The Specific cell option is now the Based on header option, which accepts the column title as
either the column heading or the default column title.
Using the Get cell address action on page 1566

Edit a work item without changing its status
You no longer have to change the status of a new work item for editing. You can now edit work
items that are in New status. Previously, you were allowed to edit the work item attribute values
after changing the state of the attributes so that the edits to the work item could be saved.
Edit work items on page 2842

Mark work items for reprocessing
The Ready to run action is now updated to Re-process so that you can mark work items that are
in Failed, Data error, or On hold state to New status for reprocessing.
View work items on page 2841 | Редактирование очередей on page 2829

Исправленные функции

ID обращения к облачному
сервису

Описание

00560339 You can now do a second checkout of the same бот, make
updates (for example delete a command) , and check it back in.
The "File Not Found" error that prevented subsequent checkouts
of the same бот and data deletion not actually getting deleted
has been fixed.

-- Devices running an older version of the Bot Agent can now
connect to A2019.12 Control Room.

-- Secure Data Store (SDS) installation on Enterprise A2019.12 is
now working.

00530388 Multiple бот updates and check-ins succeed irrespective of the
Enterprise A2019 version used to import the бот.
Бот check-in on Cloud deployments used to fail when the бот
was imported multiple times and overwritten. This issue is now
fixed.

00521691 After Excel files are extracted from a .zip file, common tasks
such as renaming and deleting the Excel files failed. This issue is
now fixed.

00519528 Bot Scanner version 2.0.0 now works as expected. The crash
issue is now fixed.
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Исправленные функции

ID обращения к облачному
сервису

Описание

00517040 When the Эл. почта пакет is used in Exchange Web Services,
the action loop exited after processing 10 emails. This early exit
is fixed. Now all specified emails are processed before the loop
exits.

00504163 When боты are run using the Open and Close actions from the
DLL package in a loop, the Bot Agent window now functions
correctly. The Bot Agent service does not require a manual
restart after a бот is run.

00494267 Действия from the DLL package can now be run inside and
outside a loop.

00494273 The Create worksheet action in the Расширенный Excel
пакет now supports default sheet names for all the supported
languages in Enterprise A2019.

00492554 The Sort table action in the Расширенный Excel пакет now
supports OS setting for the Swedish region.

00446956 The Open action in the CSV/TXT пакет can now read values
from files encoded with UTF-8.

00503230 The Веб-служба SOAP action now supports responses with non-
English characters.

00522147 The $StringVar.String:trim$ shorthand now trims leading and
trailing spaces in a string when used in the Message box
пакет.

-- You can now deploy боты on selected Bot Runner devices with
the Run as option from the My bots page in an Control Room
configured on Microsoft Azure.

-- Scheduled боты now run as expected and do not get stuck in
the queue in an Control Room configured on Microsoft Azure.

-- After you capture an object in a browser or application
window, the browser window containing the Bot editor is now
reactivated. Previously, users had to manually return to the Bot
editor.
Действия in the Распознавание изображений, Мышь,
Распознавание текста (OCR), Экран, and Средство записи
пакеты support this feature.

00475070 Exporting a report to CSV from Activity > Historical now
correctly outputs the data.

00516331 You can now build a бот that contains more than one
Database > Read from action that is followed by a Loop
action, within the same database session. Each time the бот
runs the Read from action, the query results are refreshed,
and the loop will only iterate on the current results.
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Исправленные функции

ID обращения к облачному
сервису

Описание

00509735 Auto Login now works when you deploy a бот as an unattended
Bot Runner on a Horizon Virtual Desktop Infrastructure (VDI)
session.

00509831 Запрос пакет actions now support long inputs. The user
interface displays up to 512 characters. If the input is longer
than 512 characters, the rest appear as a tooltip when the user
hovers over the prompt box.

00518566 You can now use the recorder feature within actions to
select window titles and file paths on a device that has proxy
authentication enabled. Previously, users had to manually enter
this information because they could not access the device
through actions while building a бот.

00475107 The Japanese language now supports column names when
using CSV-related actions.

00532894
00532253
00539241

When you reimport a бот using exported files from a different
Control Room of the same version (from version A2019.12
onward) and choose to overwrite the бот, you can now check-
in that бот. The error generated when you choose the overwrite
option that prevented check-in of the reimported бот is now
fixed only for version A2019.12 onward. Reimporting боты on
A2019.11 and older releases are not supported at this time.

00521222, 00525635, 00529274,
00526613, 00526489, 00530609,
00530787, 00533445, 00535366,
00530900, 00538070

The progress of a TaskBot is not stalled at line 0 and does
not remain in queue to run when you deploy the бот on a
Bot Runner. The status of the device reflects Yet to Be
Determined until the device is available to process the items.

00421195 You can now create a work queue by providing details such as
the queue name, queue owners, participants, consumers, and
work item structure. This feature is available from Workload >
Queues > Create Queue.

00533465 When you delete any action from an existing бот, the
corresponding metadata for the deleted action is now removed
from the бот.

Известные ограничения

If you are running A2019.12 Enterprise On-Premises with build 4105 on Linux and want to use
Сборка 4111, then you must uninstall Build 4105 and do a fresh installation of Сборка 4111. You
cannot perform an upgrade to get Сборка 4111. См. раздел Uninstall Automation 360 On-Premises
from Linux server on page 960. A2019.12 Enterprise On-Premises on Windows can be upgraded as
normal.

The Send reset password email functionality (from the Administration > User page) to help
users reset their password is not working and returns a 401 error. Users should use the "Forgot
password?" flow to reset their password.

Folders created using the Folder > Create action cannot have names that contain system actions
or device references such as AUX, CON, LPT, NUL, and PRN.
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Известные ограничения

Mouse click with key combo for preset triggers in SAP application is currently not supported.

The following are known limitations in the form builder:
• If the character limit is set to 0 and the field is marked necessary for the Password element in

a form, an error message is displayed when you run the бот.
• An invalid file path associated with the Document element in a form displays an error message

when the Get and Set actions of the interactive forms are used.
• A blank page is displayed on the form builder when you paste content into any of the existing

form elements.
• A form that is linked to a бот through the Display action of interactive forms is displayed in

front of all other windows, even when the Always display form window in front option is
not selected.

Cloud-enabled deployments only support local authentication.

Linux is not supported for Cloud-enabled On-Premises installations.

• Work items might be queued on the View queues page as the number of devices in the device
pool increase. This should not affect the бот execution because the queues are cleared when
the work items are processed.

• You cannot simultaneously insert work items from multiple devices in a queue.
• You cannot create a draft queue.
• When you insert a number value using the Insert work item to a queue, the system shows an

incorrect value. For example, if you insert 023456789, the system shows 2.3456789E7.
• When you add more devices to a device pool that is processing workload management

automations, the newly added devices might not immediately pick up the pending work items.
Обходное решение. Pause and resume the workload management automation.

If a device goes idle while processing workload management work items in a device pool, it will not
process the work items. However, those work items can be processed by other devices in the pool.

When you create a form with using the Document element and provide an incomplete file path,
your бот will not run successfully.

When you create a form and specify that a password is required, the password length can be set to
0.

IQ Bot (Build 4088)

Enterprise A2019.12 Сборка 4111 is compatible with IQ Bot A2019 (Build 4088).
The IQ Bot On-Premises version supports all the features and functionality available in IQ Bot Version
6.5.2.
IQ Bot feature comparison matrix

Review the compatibility of the IQ Bot On-Premises version with the corresponding Automation Anywhere
Control Room On-Premises version.
Automation 360 IQ Bot version compatibility on page 745
The IQ Bot Cloud version is available for this release and supports all features and functionality available in
IQ Bot Version 6.5.2. This version provides users with automatic provisioning for up to three environments
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such as Development, Test, and Production. Users can migrate learning instances between environments
using APIs.
The IQ Bot Community Edition and the free trial version are available for this release. Both versions have
feature parity and are based on IQ Bot Version 6.5.2.

Известные ограничения

IQ Bot On-Premises
IQ Bot registration is not supported for Cloud-enabled On-Premises installations.

Bot Insight

Новые функции

View filtered data of the dashboard widgets
Enterprise A2019 and Community Edition
The Bot Insight dashboard widget filter enables you to apply filters across the widgets in the
dashboard to display filtered data. While the dashboard filters enable you to view different
combinations of information from a single dashboard, the widget filters enable you to drill down to
information from the already filtered data. You can also save and publish the custom dashboards
with the preset widget filters.
Bot Insight dashboard filter on page 2982

Retrieve information from the Bot Insight API, and generate and visualize data
analytics on Microsoft Power BI
Enterprise A2019 and Community Edition
The Automation Anywhere custom connector enables you to establish a secure connection to
Microsoft Power BI, and generate and visualize data analytics. You can select the Bot Insight APIs
in Microsoft Power BI and apply specific parameters for each of the APIs. The custom connector
transforms the Bot Insight API responses to data model visualizations in Microsoft Power BI.
Data connector for Power BI on page 2995

Preview and analyze business information in the default business dashboard
Enterprise A2019 and Community Edition
The Data Preview menu in the Bot Insight default business dashboard displays information that
is logged for multiple Analyze Open and Close commands used in the бот. The Preview Data
menu does not appear when you perform a comparison between the default dashboards.

API enhancements
Enterprise A2019
The deletetasklogdata API is updated to include the runId parameter. The getbotrundata
API retrieves information about the vital statistics of the бот. The getaudittraildata API
retrieves information about the audit data that is logged for all users.
Bot Insight API

Related concepts
Миграция в Automation 360 on page 1133
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Related tasks
Обновление до последней версии Automation 360 on page 1070
Если вы уже используете Automation 360 On-Premises, этот продукт можно обновить до последней
версии Automation 360.
Updating Automation 360 IQ Bot on page 1120
Update Automation 360 IQ Bot On-Premises to the most recent version for all the latest features and
enhancements.

Enterprise A2019.11 Release Notes
Review the new features, supported packages, changed features, fixed features, and known limitations in
the Enterprise A2019.11 (Сборка 3337) release. There are no security fixes in this release.
• Enterprise A2019
• IQ Bot
• Bot Insight

Enterprise A2019

Important:  This release includes a required update to your . Ensure that you complete the update to
continue with your automation activities when upgrading from a previous release to this release.

Автоматическое обновление Bot Agent on page 1049 | Обновление Bot Agent вручную on page 1050

To verify which  version is compatible with this release, see Compatibility with release builds on page 1033.

Новые функции

Migrate 11.x TaskBots and MetaBots to Enterprise A2019
Enterprise A2019
• Additional support is provided for packages and variables.

Сопоставление пакетов для миграции on page 1258 | Сопоставление переменных для
миграции on page 1293

• You can now migrate MetaBots (with DLLs) and their components from Enterprise 11 to
Enterprise A2019. You cannot migrate screen-based MetaBots.

Как выполняется миграция MetaBots on page 1234
• Use the Bot Scanner to analyze MetaBots to determine if they can be migrated.
• Verify the list of certified Enterprise 11 бот versions available for migration: Поддерживаемые

для миграции версии Control Room on page 1143
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Новые функции

Bot Store integration with the Control Room
Enterprise A2019
You can now access the Bot Store from within the Control Room. You can install, configure, and run
the Bot Store боты within the Control Room.
As a registered user, you can log in to the Bot Store from the Control Room and access all your
downloads. You can install боты and packages from your downloads to the Control Room private
repository. You can also submit your existing боты and packages from the Control Room to the Bot
Store.
Bot Store on page 2960

Use interactive forms in a бот
Enterprise A2019
Interactive forms provide a form builder experience for users to build interfaces for submitting and
regrouping data being used to send and receive data from various applications within their attended
automation process. Users with Bot Creator and Bot Runner license can use the interactive forms
package to control and manage the form flow within a бот during runtime. Actions performed by
users on the interactive forms can be monitored to execute logic using subtasks.
Interactive forms are first-class citizens within the бот repository and have the same workflows
for moving forms between public and private workspaces, and for export or import actions. No
additional licenses or permission are required to use interactive forms.
Action items in the interactive forms can be used to manage various forms within a бот.
Using interactive forms on page 2202

Reuse an identical value between боты by configuring a global value in the Control
Room
Enterprise A2019 and Community Edition
A global value enables users to reuse an identical value between боты instead of creating a new
variable for each бот. Global values remain constant for all users and боты in an Control Room
instance. A user with the AAE_admin role can configure a global value with a default value and
enable non-admin users to overwrite the value to use in their боты.

Глобальные значения on page 2058 | Создание глобального значения on page 2058 | Overwrite
the default value on page 2060
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Новые функции

Workload enhancements
Enterprise A2019 and Community Edition
• Monitor the progress of ongoing workload automations. You can also pause, resume, or stop the

automations as required.
• Configure and edit workload automations to ensure that the automations are deployed

seamlessly to unattended Bot Runner devices. Execute the workload automations with priority or
round-robin mode from the Devices > Edit Device pool page.

• Set the output status of the work item processed in the Control Room on the Queues and
Work item details page using the $workItemResult$ variable in a TaskBot.

• Edit work items that are in Ready to run, On hold, Data error, or Failed state.
• Set the individual work item status to Mark complete, Defer, or Re-process from the Edit

work item page or in bulk from the View queues page.

View automation of a queue on page 2836 | Edit device pools on page 2653 | Edit work items on page
2842 | Use Work Item variables on page 2052

Download a file from the Control Room to your device
Enterprise A2019 and Community Edition
Use the Download CR file action from the Файл пакет to download a file from the Control Room
to your device.

Note:  You cannot use this action to download a бот or a file from the My Scripts folder.

Файл пакет on page 1575

Clone a бот or files
Enterprise A2019 and Community Edition
Create a read-only copy of a selected бот or file from the public repository to the private repository.
The clone is a local copy for the same user and will not be updated with the public repository copy
automatically. This provides a testing environment experience for Bot Creator to make and validate
changes locally and take advantage of reusable TaskBots in concurrent developments by reusing an
existing бот or file as a dependency.
• Cloned боты and files cannot be edited, renamed, or moved.
• Cloned боты and files can be deleted from a private repository.
• Users can create a copy of the cloned бот.
• A cloned бот can be used in Выполнить задачу action in another бот.
• Cloned боты and files can be added as a manual dependency for another бот.

New features in the Если пакет
Enterprise A2019 and Community Edition
• Configure an If action with multiple conditions.

Specify whether all or either of the conditions must be met.
• Verify whether JavaScript, Task, or VBScript ran successfully or not.
• Verify whether a string variable is empty or not.
• Execute actions only if two strings have matching uppercase and lowercase letters.

Если пакет on page 1639 | Example of using a conditional statement on page 2073
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Новые функции

Universal Recorder enhancements
Enterprise A2019 and Community Edition
Universal Recorder now enables you to:
• Automate in Java applications that run using Java Runtime Environment (JRE) 9, 10, and 11.
• Capture objects in tables in Oracle EBS applications.
• Automate interactions with user interface objects in the taskbar, desktop, or currently active

window. This option is available in the window selection drop-down list in the following пакеты:
• Распознавание изображений
• Мышь
• Средство записи
• Экран
• Имитация нажатия клавиш
• Окно

Universal Recorder for object-based automation on page 1963

New features in the Расширенный Excel пакет
Enterprise A2019 and Community Edition
• In the Replace action, you can choose to replace cell values with an empty character.
• In the Get cell address action, you can choose to save the retrieved cell address to a string

variable.

Using the Replace action on page 1570 | Using the Get cell address action on page 1566

Add DLL dependencies
Enterprise A2019 and Community Edition
As a бот creator, you can use a DLL that refers to a child DLL.

Бот dependencies on page 2060

Licensing server failover
Enterprise A2019
HA failover from a primary cluster to a secondary cluster applies to all the servers, including the
licensing server, and is handled by the data center high availability tools.
Distributed architecture with HA/DR support on page 22

Automate locking, logging off, restarting, or shutting down the computer
Enterprise A2019 and Community Edition
Use actions from the Система пакет at the end of tasks to automate locking, logging off, restarting,
or shutting down the computer.
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Новые функции

Manage running боты with the Pause and Stop actions from the TaskBot пакет
Enterprise A2019 and Community Edition
• Insert a Pause action to temporarily pause the running бот.
• Insert a Stop action to terminate the running бот.

TaskBot пакет on page 1909

Automate printer settings
Enterprise A2019 and Community Edition
Use actions from the Принтер пакет to automate retrieving and setting the default printer.

Return the path and name of the currently running TaskBot using the system variable
AATaskName
Enterprise A2019 and Community Edition

Предварительно определенные переменные on page 2037

Run JavaScript, Python, or VBScript from a file selected from your desktop
Enterprise A2019 and Community Edition
You can select the file containing the script as part of configuring the action.

Note:  The file and any dependencies must be in a standalone folder. When you select a file for
upload, all files and folders at the same folder level are uploaded.

JavaScript пакет on page 1678 | Python Script пакет on page 1761 | VBScript пакет on page 1935

Device optimization for бот deployment (Zendesk ID: 238675)
Enterprise A2019 and Community Edition
Bot Runner devices that are used for Workload automation are now available for deployment in
the Scheduled Automations page. This ensures that idle devices during a workload cycle are
available to the user with scheduling rights for Control Room deployment.
Edit device pools on page 2653

Поддерживаемые пакеты

Пакет Версия

Node Manager 6.0.4015

Приложение 2.0.0-20200302-135910

Анализ 2.2.1-20200314-193039

Логический 2.0.0-20200302-135912

Браузер 2.0.0-20200302-135913

Буфер обмена 2.0.0-20200302-135922

Комментарий 2.0.0-20200302-135922
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Пакет Версия

CSV/TXT 2.0.0-20200312-122802

База данных 2.0.0-20200302-135926

Таблица данных 2.0.0-20200302-140308

Дата/время 2.0.0-20200302-135930

Задержка 2.1.0-20200302-135931

Словарь 2.0.0-20200302-135932

Run DLL 2.0.0-20200313-170350

Эл. почта 2.0.0-20200302-135934

Обработчик ошибок 2.0.0-20200302-135940

Базовый Excel 2.0.0-20200302-140133

Расширенный Excel 2.0.0-20200302-140020

Файл 2.0.0-20200316-045955

File & folders 2.0.0-20200317-030352

Папка 2.0.0-20200302-135945

FTP / SFTP 2.0.0-20200302-135948

IF/ELSE 2.0.0-20200302-135950

Распознавание изображений 2.0.0-20200302-135953

IQ Bot 2.0.0-20191031-150538

JavaScript 2.0.0-20200313-170107

Имитация нажатия клавиш 2.0.0-20200313-170111

Legacy Automation 1.0.0-20200317-220124
1.0.0-20200317-220128

Список 2.0.0-20200302-140013

Записать в файл 2.0.0-20200302-140014

Цикл 2.0.0-20200302-140015

Message Box 2.0.0-20200302-140016

Миграция 2.0.0-20200317-220133

Мышь 2.0.0-20200302-140016

Число 2.0.0-20200302-140023

Распознавание текста (OCR) 2.1.0-20200302-140025

Office 365 Excel 2.0.0-20200309-140138

Календарь Office 365 2.0.0-20200305-124125

Office 365 OneDrive 2.0.0-20200309-110128

PDF 2.1.0-20200302-140126
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Пакет Версия

PGP 2.1.0-20200309-110135

Ping 2.0.0-20200302-140130

Принтер 2.0.0-20200311-100204

Воспроизвести звук 2.0.0-20200309-110137

Запрос 2.0.0-20200302-140148

Python Script 2.0.0-20200313-170254

Средство записи 2.0.0-20200318-020414

Веб-служба REST 2.0.0-20200312-090358

SAP 2.1.0-20200302-140250

Экран 2.0.0-20200302-140254

SNMP 2.0.0-20200302-140257

Веб-служба SOAP 2.0.0-20200312-110311

Строка 2.0.0-20200302-140306

Система 2.0.0-20200309-140321

Задача 2.0.0-20200317-030340

Эмулятор терминала 2.0.0-20200302-140313

VBScript 2.0.0-20200313-170417

Ожидать 2.0.0-20200302-140319

Окно 2.0.0-20200302-140348

XML 2.0.0-20200302-140321

Измененные функции

Change in the Dictionary > Remove action
The Dictionary > Remove action offers the option to assign the removed value to a variable.
Dictionary пакет on page 1492

The Update migration status permission name has been changed to Allow a bot-runner user
to run migrations. All functionalities remain the same.

When multiple боты are scheduled to run on the same user or device, the боты are now queued
and run whenever the previous боты completes its run.
Service Cloud case ID: 00440072
Scheduled activities on page 2631 | Управление рабочей нагрузкой on page 2813
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Исправленные функции

ID обращения к облачному
сервису

Описание

00483976 When the copy function is used, nested subfolders were not
visible when users clicked browse to search through directories.
This issue has been fixed.

00457550 When a user checks out a бот that uses the Run action to
run child боты, the child боты are now cloned from the public
repository to the private.

00492706 When a user exports a бот from another Control Room and
imports that same бот to a new Control Room, the imported бот
and enabled packages now show all required actions.

00482934 Бот deployments and website launches are now optimized for
quicker process.

00421864 When a user is viewing historical activity details in Historical
activity, the run option is no longer displayed.

00505120 When боты fail the check-in process, the contents are now
restored in the Private repository.

00488504 Боты with more than 100 dependencies are now exported
successfully without an error, even if the parent боты are in the
list of those 100 dependencies.

00444902 When the Control Room is used in Internet Explorer 11, the Bot
Agent is now compatible and the UI is rendered properly.

00454079 When the Capture action in the Средство записи package is
used, content in the browser is captured successfully.

00460530 In a developer Control Room, a user can now successfully
import a бот with cyclic dependency.

00493605 In the Run action in the TaskBot package, the Assign the
output to variable (optional) option now functions properly
when an assigned variable is removed.

00486734 When the Set cell action in the Расширенный Excel or
Базовый Excel пакет is used with multiple Microsoft Excel files,
the values of the Active cell operation now activate and set the
cells accordingly in the respective Microsoft Excel file.

00530915 Migration is not advisable for Enterprise 11 customers using
Workload Management due to known issues.

-- You can now add date variables in the Vertical Bar Graph
widget in the Bot Insight Business dashboard.

00475173 All fields of the Recorder > Capture action have been
translated to Enterprise A2019 supported languages.

00476820 When a Bot Runner machine is logged off, the device shows
the state as Disconnected in the Control Room. Previously, the
device showed the state as Connected in the Control Room.
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Известные ограничения

MetaBot logic that uses a DLL function call with one or more parameters migrates successfully.
However, when you run the migrated бот, an error is shown.

Global values of the Date time data type cannot be used in actions.

The Enterprise A2019 On-Premises Control Room installation does not support the semicolon
(;) special character in the Windows user password. The installation fails if you use this special
character.

When data is exported into a CSV file from User Management, Audit Logs, and Roles
Management for all locales except English, the respective language is not displayed correctly.
Workaround: Export to a CSV file and access a Microsoft Excel file. Import and save that CSV file as
a CSV with UTF-8 encoding.

Users must explicitly enable the feature flag for the forms feature in the On-Premises build.

Note:  Go to Automation Anywhere support site for more information: Interactive forms not available
in Automation 360 v.11 On-Premises (A-People login required)

Forms with many radio buttons and check boxes in the same row are not rendered correctly.

Only the Form Events and UI Triggers event types are supported by event loop as the file or
folder triggers and hot keys have issues.

IQ Bot

The IQ Bot On-Premises version is available for this release with additional features or updates since the
last release. This IQ Bot version supports all the features and functionality available in IQ Bot Version
6.5.2.
IQ Bot feature comparison matrix

Review the compatibility of the IQ Bot On-Premises version with the corresponding Automation Anywhere
Control Room On-Premises version.
Automation 360 IQ Bot version compatibility on page 745
The IQ Bot Cloud version is available for this release and supports all features and functionality available in
IQ Bot Version 6.5.2. This version provides users with automatic provisioning for up to three environments
such as Development, Test, and Production. Users can migrate learning instances between environments
using APIs.
The IQ Bot Community Edition and the free trial version are available for this release. Both versions have
feature parity and are based on IQ Bot Version 6.5.2 .

Новые функции

Upgrade from earlier versions of IQ Bot to the latest IQ Bot On-Premises
IQ Bot On-Premises
If you are using any of the earlier versions of IQ Bot (5.3.x or 6.5.x), you can upgrade to IQ Bot
A2019 Сборка 3337 On-Premises.
Updating Automation 360 IQ Bot on page 1120
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Новые функции

Use API to migrate learning instances between environments
You can use an API to migrate learning instances in IQ Bot On-Premises.

Access IQ Bot from the Control Room dashboard
Enterprise A2019 and Community Edition
You can access IQ Bot from the Control Room through a link, provided you have registered IQ Bot
in the Control Room. Otherwise, the IQ Bot section remains hidden.

Известные ограничения

IQ Bot On-Premises
IQ Bot installation fails if the user password contains any of these special characters: single
quotation mark ( ' ), quotation mark ( " ), or semicolon ( ; ).

IQ Bot Cloud
• ABBYY FineReader Engine is the default OCR for data extraction in IQ Bot Cloud.
• Data validation using Python script is not supported.
• IQ Bot extensions for custom extraction are not available.

IQ Bot On-Premises and IQ Bot Cloud
При загрузке векторных PDF-документов в новый обучаемый экземпляр несколько документов
определяются как неклассифицированные. Если же преобразовать документы из PDF в TIFF и
загрузить их, эти документы будут успешно обработаны.

Bot Insight

Новые функции

View filtered data of Bot Insight dashboards
Enterprise A2019
The Bot Insight dashboard filter enables you to apply filters across dashboards to display filtered
data on the dashboard widgets. The filter enables you to view different combinations of information
from a single dashboard, thereby eliminating the need to maintain separate dashboards for
different sets of users.
Bot Insight dashboard filter on page 2982

View business analytics for multiple transactions simultaneously
Enterprise A2019
The Multiple Transaction Names menu displays transactional information about боты with
multiple Analyze- Open and Close commands. Each Analyze- Open and Close command is
considered as a transaction, and each transaction is displayed as a unique block in the data preview
section. The number of rows for each unique transaction block is limited to 100.
Business dashboard on page 2977
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Enterprise A2019.10 Release Notes
Review the new features, supported packages, changed features, fixed features, and known limitations in
Enterprise A2019.10 (Сборка 2545). There are no security fixes in this release.
• Enterprise A2019
• IQ Bot
• Bot Insight

Enterprise A2019

To verify which  version is compatible with this release, see Compatibility with release builds on page 1033.

Новые функции

Migrate 11.3.x TaskBots to Enterprise A2019
Enterprise A2019
• Analyze whether you can migrate боты created in Enterprise Client version 10.x using the Bot

Scanner.

Анализ отчета Bot Scanner для миграции on page 1171
• Additional support is provided for packages and variables.

Сопоставление пакетов для миграции on page 1258 | Сопоставление переменных для
миграции on page 1293

• Multiple Bot Runner users are supported for бот migration.

Миграция корпоративных боты on page 1227

AISense Recorder to capture objects from remote applications
This is a Beta release on Enterprise A2019 (Cloud deployment only) and Community Edition
Record a task and capture objects using the AISense Recorder from applications that are usually
accessed remotely and with a complex user interface (UI).
Record a task with AISense Recorder on page 1980

Manage your automation as Work Items for resource optimization and workload
automation
Enterprise A2019 and Community Edition
Divide your automation into small, logical modules called Work Items using the new Workload
Management feature. Process these Work Items simultaneously using queues to ensure that your
organization's automation goals are achieved with optimum resource utilization.
Use the workload module to create and manage workload queues and run боты on unattended Bot
Runner through the workload queues. Also, pass the Work Item attributes or values to the бот from
the Control Room when you Run bot with queue with the help of Work Item variables.

Управление рабочей нагрузкой on page 2813
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Новые функции

Install Control Room on Red Hat Enterprise Linux 7.7 and Linux CentOS 7.7
Enterprise A2019
Use the command line to install your Control Room on your Linux servers in the datacenter.
Installing Control Room on Linux on page 953

Use wildcard characters in folder and file path fields in the Encrypt and Decrypt actions
Enterprise A2019 and Community Edition
Substitute an asterisk (*) for one or more unknown alphanumeric characters or symbols. This
maximizes the search results by returning all folders and files that contain the string that you have
specified.
Encrypt | Decrypt

Use system variables to return data from the computer that is connected to the running
Bot Agent
Enterprise A2019 and Community Edition
You can use the following system variables:
• AAControlRoom: Returns the URL of the Control Room.
• CPUUsage: Returns the percentage utilization of the CPU.
• RAMUsage: Returns the RAM usage in megabytes.
• OSName: Returns the operating system.
• TotalRAM: Returns the total amount of RAM available.

Automate tasks in Oracle EBS and Forms with the Universal Recorder
Enterprise A2019 and Community Edition
Open Oracle EBS applications in a browser as Java Web Start applications or as a thick client. The
Universal Recorder can capture the following objects:
• Window/Tab
• Кнопка
• Текстовое поле
• Label (read-only)
• Переключатель
• Флажок
• Table/Grid
• Scroll bar
• Меню
• Combo-box/Drop-down list

Поддерживаемые пакеты

Пакет Версия

Node Manager 2.0.2885

Приложение 2.0.0-20200131-085947

© 2023 Automation Anywhere. All rights reserved.     611



    Automation Anywhere - Learn

Пакет Версия

Анализ 2.1.0-20200204-154550

Логический 2.0.0-20200131-085949

Браузер 2.0.0-20200127-180439

Буфер обмена 2.0.0-20200131-085958

Комментарий 2.0.0-20200130-183435

CSV/TXT 2.0.0-20200205-175938

База данных 2.0.0-20200205-175940

Таблица данных 2.0.0-20200131-200235

Дата/время 2.0.0-20200131-090006

Задержка 2.1.0-20200131-090007

Словарь 2.0.0-20200205-175946

Run DLL 2.0.0-20200205-230300

Эл. почта 2.0.0-20200206-135926

Обработчик ошибок 2.0.0-20200130-183452

Базовый Excel 2.0.0-20200205-110122

Расширенный Excel 2.0.0-20200205-110012

Файл 2.0.0-20200131-090018

Папка 2.0.0-20200131-090021

FTP / SFTP 2.0.0-20200206-110020

IF/ELSE 2.0.0-20200131-090025

Распознавание изображений 2.0.0-20200131-090028

IQ Bot 2.0.0-20191031-150538

JavaScript 2.0.0-20200205-180013

Имитация нажатия клавиш 2.0.0-20200205-105955

Список 2.0.0-20200131-090039

Записать в файл 2.0.0-20200131-090040

Цикл 2.0.0-20200131-090041

Message Box 2.0.0-20200131-090041

Миграция 1.1.0-20200206-180601

Мышь 2.0.0-20200131-090044

Число 2.0.0-20200205-110015

Распознавание текста (OCR) 2.1.0-20200131-090053

Office 365 Excel 2.0.0-20200205-180122

Календарь Office 365 2.0.0-20200206-105949
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Пакет Версия

Office 365 OneDrive 2.0.0-20200127

PDF 2.1.0-20200131-090152

PGP 2.1.0-20200205-110117

Ping 2.0.0-20200131-090156

Воспроизвести звук 2.0.0-20200127-180654

Запрос 2.0.0-20200127-180707

Python Script 2.0.0-20200205-180148

Средство записи 2.0.0-20200212

Веб-служба REST 2.0.0-20200206-110309

SAP 2.1.0-20200205-180245

Экран 2.0.0-20200131-090311

SNMP 2.0.0-20200207-090446

Веб-служба SOAP 2.0.0-20200127-180819

Строка 2.0.0-20200131-090323

Система 2.0.0-20200205-110240

Эмулятор терминала 2.0.0-20200131-090330

VBScript 2.0.0-20200205-180309

Ожидать 2.0.0-20200131-090335

Окно 2.0.0-20200131-090337

XML 2.0.0-20200131-090339

Измененные функции

Updated layout for the summary report generated by Bot Scanner
The layout of the summary report is updated to provide information about the number of боты
scanned, and the commands and variables used in the scanned боты that are supported in
Enterprise A2019.

Анализ отчета Bot Scanner для миграции on page 1171

Python script and VBScript пакеты return output without quotation marks
The actions in the Python script and VBScript пакеты now return output without any quotation
marks. For example, if the action previously returned "ABC" as the output, now the action returns
only ABC.

Use Microsoft SQL Server address as alias for database
Service Cloud case ID: 00401484
The Control Room now supports using a Microsoft SQL Server address as alias for a database
during installation.
Automation 360: Steps to change database server post Control Room installation (A-People login required)
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Исправленные функции

ID обращения к облачному
сервису

Описание

00463210 In a virtual machine using Remote Desktop Protocol, the
Keystrokes action now functions properly without prompting a
special characters error.

00455359, 00466407, 00475122 When the Control Room is used in Google Chrome, renaming a
folder in the My bots section no longer causes the browser to
crash.

00440659 In the Data Table пакет, the Create folders/files if it
doesn't exist option in the Write to file action now functions
properly and does not create a file when the option is not
selected.

00377861, 00466104 When you install Enterprise A2019 On-Premises with Amazon
Relation Database Service (RDS) and there is no internet
connectivity, the installation now completes successfully.

00472738, 00496476 In the Control Room, the бот now runs successfully
without prompting an interactive бот error message in any
circumstance.

00472655 In the Цикл action, selecting the Cell range in the Loop
through option now functions properly with the For each row
in worksheet in the Iterator option.

00475040 When a бот is developed in Google Chrome, the pause and
resume options now function correctly.

00445671 The time taken to connect to the Control Room is now less than
2 minutes after you restart the Control Room services.

00421864 You can now configure your Bot Agent using the Google Chrome
browser. Приведенное ниже сообщение об ошибке больше не
отображается. Please use Chrome to configure your
bot agent.

00462095 Бот compilation time has decreased, so it takes less time for the
бот to run. Previously, some боты took up to 40 seconds in pre-
processing mode.

IQ Bot

The IQ Bot On-Premises version is available for this release with additional features or updates since the
last release. This IQ Bot version supports all the features and functionality available in IQ Bot Version
6.5.2.
IQ Bot feature comparison matrix

Review the compatibility of the IQ Bot A2019 On-Premises version with the corresponding Automation
Anywhere Control Room On-Premises version.
Automation 360 IQ Bot version compatibility on page 745
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Новые функции

IQ Bot On-Premises unified database
IQ Bot Сборка 2545 On-Premises now supports a unified database. You have to run a migration
script to migrate the databases of Builds 1089, 1598, and 2079 to Сборка 2545.
Run IQ Bot On-Premises database migration script on page 1121

Note:  The version number in the IQ Bot installer is incorrect and will be fixed in the next release.

Bot Insight A2019

Новые функции

New Bot Insight homepage
The new homepage displays all the available dashboards in a single page and enables you to
directly access the dashboard of your choice. The smart search functionality enables you to search
for dashboards in the Search text field. The homepage also enables you to bookmark your favorite
dashboards and to sort the dashboards based on the following parameters:
• Dashboard Name
• Type
• Total Views
• Last Refreshed

Информационные панели Bot Insight on page 2972

Operations dashboard
View information about the боты that are deployed on different Bot Runner machines and their
statistics based on the performance from the Bot Insight Operations dashboard. You can use this
information to enhance productivity and take measures based on real-time information for RPA
deployments.
You can directly access the Bots and Audit dashboards from the hyperlinks in the Operations
dashboard.
Operations dashboard on page 2975

Transaction data
View data that is aggregated and logged by the боты when they are deployed in the Bot Runner
machines by using the Transaction data feature in the Profile menu. You can access this feature
from the Business dashboard.
Business dashboard on page 2977
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Новые функции

Exporting data from widgets
Export data that is generated by the various smart widgets to comma-separated value (CSV) files
on your local drive from the Custom Business dashboard. The export file for all the widgets,
except the Data Table Chart and the US Map, contains the following headers:
• Группа
• Subgroup
• Измерение
• Volume

The Data Table Chart export file contains all the headers that are present in the Data Table
Chart. The US Map export file contains the state codes, metric values, and the volume headers.
Exporting data from a dashboard widget on page 2995

Visualization updates
Customize the widgets on the Bot Insight dashboards to gain insights for specific scenarios. The
following widgets are added to Bot Insight:
• Heat Map
• Data Table Chart

Bot Insight visualizations on page 2992

Известные ограничения

Using the Universal Recorder in Oracle EBS applications:
• The Select item by text action does not retrieve the value of a selected ListView object.

Workaround: Manually enter the item value after capturing the object control or use the Select item
by index action.

Note:  Item index count starts at 1.

• At runtime, the Select item by text and Select item by index actions do not appear to select the
item specified in a PageTab object, but the бот successfully executes the action.

• At runtime, the Select item by text and Select item by index actions do not appear to select the
item specified in a ComboBox object, but the бот successfully executes the action.

In Enterprise A2019 On-Premises, the following activities are currently not logged in the workload logs:
• Create a queue
• Create a device pool
• Create a бот
• Run a бот with a queue

You can access the logs from the C:\ProgramData\AutomationAnywhere\Logs folder.
Related information
https://www.automationanywhere.com/in/lp/rpa-editions-comparison
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Enterprise A2019 (Build 2094) Release Notes
These release notes describe new features, changed features, fixed features, security fixes, deprecated
features, and known limitations in Enterprise A2019 (Build 2094).
To verify which  version is compatible with this release, see Compatibility with release builds on page 1033.

Enterprise A2019 Build 2094

Build 2094 contains updates for the following:
• Enterprise Community Edition
• Bot Insight A2019
• IQ Bot A2019
• On-Premises (Build 2079)
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New features in Build 2094

Функция Описание

Миграция Migrate Enterprise 11.3.x TaskBots to Enterprise
A2019.
• Run the Bot Scanner (previously called

the pre-migration utility) to analyze if your
Enterprise 11.x бот (currently only 11.3.1,
11.3.2, and 11.3.2.x versions are supported)
can be migrated to Enterprise A2019. The
utility generates a summary report in HTML
format and a separate report for each бот in
XML format.

Обзор Bot Scanner on page 1166
• Migrate multiple TaskBots with dependent

TaskBots using a single Run-as user.

Миграция корпоративных боты on page
1227

• As part of the бот migration process, you
can identify previously migrated TaskBots on
the бот selection page and preview a list of
the dependent TaskBots before finalizing the
migration.

Миграция корпоративных боты on page
1227

• Analyze the status of individual бот
migrations and identify any unsupported
commands or attributes associated with the
migrated бот and its dependencies.

Просмотр отчетов о переносе данных on
page 1315

• Additional support is provided for packages
and variables.

Сопоставление пакетов для миграции on
page 1258

SAML 2.0 Switch an authenticated environment Control
Room database to a SAML identity provider
(IDP).

Настройка аутентификации SAML on page
1001
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Функция Описание

Бот Deploy API The Бот Deploy API now includes /
automations/deploy and is introduced
to support the runAs user feature for Бот
deployment.
• The Бот Deploy API works only in Enterprise

public accounts, and not in Community
Edition.

• The API supports callback URL for
environments that have both the Control
Room and callback server on the same
network.

Geo Presence The Geo Presence feature is a multi-tenant,
secure, scalable, Cloud Control Room
enhancement to securely communicate with
users and Bot Runner over a customer network.

Exchange Web Services support Действия in the Email пакет enable users
to automate email-related operations using
Exchange Web Services (EWS).

Эл. почта пакет on page 1506

Variables in place of an index or key value Data table, dictionary, list, and record type
variables can express index and key values as
variables.
Variable types on page 2042

Копировать бот The copy бот functionality retains the metadata
of the original бот, including captured images,
recorded objects, called files, and child боты.
Copy a бот on page 2018

Excel actions to retrieve cell, column, or
row location

The following actions enable users to retrieve
location information from an Excel sheet and
save it to a variable.
• Get cell address
• Get column
• Get row

Recorder enhancements Users can discard the most recently captured
object while the Recorder is running.

Поддерживаемые пакеты

Пакет Версия

Node Manager 1.0.1891

Приложение 2.0.0-20191223-210256
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Пакет Версия

Логический 2.0.0-20191223-210258

Браузер 2.0.0-20191223-210259

Буфер обмена 2.0.0-20191223-210308

Комментарий 2.0.0-20191223-210309

CSV/TXT 2.0.0-20191223-210310

База данных 2.0.0-20191223-210312

DataTable 2.0.0-20191223-210802

Дата/время 2.0.0-20191223-210316

Задержка 2.1.0-20191223-210318

Словарь 2.0.0-20191223-210318

DLL 2.0.0-20191223-210742

Эл. почта 2.0.0-20200114-060001

Error Handler 2.0.0-20191223-210326

Excel 2.0.0-20200107-140225

Excel_MS 2.0.0-20200107-140116

Файл 2.0.0-20200114-060009

Папка 2.0.0-20200114-060012

FTP/SFTP 2.0.0-20191223-210334

Если/иначе 2.0.0-20191223-210336

IR 2.0.0-20191223-210339

IQ Bot 2.0.0-20191031-150538

JavaScript 2.0.0-20191223-210345

Нажатия клавиш 2.0.0-20191223-210348

Список 2.0.0-20191223-210350

LogToFile 2.0.0-20191223-210350

Цикл 2.0.0-20191223-210352

MessageBox 2.0.0-20191223-210352

Миграция 1.1.0-20200111-070201

Мышь 2.0.0-20191223-210355

Число 2.0.0-20191223-210402

Распознавание текста (OCR) 2.1.0-20191223-210525

Office 365 Excel 2.0.0-20191231-170605

Календарь Office 365 2.0.0-20191231-170422

Office 365 OneDrive 2.0.0-20191231-170612
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Пакет Версия

PDF 2.1.0-20191223-210631

PGP 2.1.0-20191223-190649

Ping 2.0.0-20191223-210634

PlaySound 2.0.0-20191223-210636

Запрос 2.0.0-20191231-130717

Python 2.0.0-20191223-210644

Средство записи 2.0.1-20200111-070529

Rest 2.0.0-20191231-120639

SAP 2.1.0-20191223-210745

Экран 2.0.0-20191223-210748

SNMP 2.0.0-20191223-210752

SOAP 2.0.0-20191210-081952

Строка 2.0.0-20200114-110316

Система 2.0.0-20191223-210800

Эмулятор терминала 2.0.0-20191223-210806

VBScript 2.0.0-20191223-210809

Ожидать 2.0.0-20191223-210812

Окно 2.0.0-20191223-210814

XML 2.0.0-20191223-210815

Измененные функции

Функция Описание

Office 365 packages authorization Authorize each Office 365 пакет separately
through the Connect пакет in each пакет.
Using Connect action for Office 365 пакеты on
page 1720

Исправленные функции

Функция Описание

Bot Agent In the Control Room, upgrading to the latest
Bot Agent version now successfully executes the
бот without any prompted error messages. См.
раздел Switch Bot Agent to a different Control Room
on page 1052.
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Функция Описание

Excel advanced package In the Excel advanced пакет, the Close action
now terminates only a specific open session as
defined by the session name.

Нажатия клавиш The Keystrokes command now functions
properly with the Japanese keyboard layout.

Исправления в системе безопасности

The security fixes in this release have not changed since the previous release. For a list of these fixes, see
Enterprise A2019 (Builds 1598 and 1610) Release Notes on page 623.

Deprecated features

The deprecated features in this release have not changed since the previous release. For a list of these
deprecations, see Enterprise A2019 (Builds 1598 and 1610) Release Notes on page 623.

Known limitations in Build 2094

Миграция
• When selecting a бот for migration, values for the Last Migrated and Migrated By columns might

differ for the same бот in the Available Files and Selected tables.
• The "System" value in the Migrated By column indicates that the бот has not been migrated

previously.
• When viewing commands and variables associated with each migrated бот, you should only see the

unsupported commands and variables. Currently, all commands and variables are shown.

IQ Bot Build 2079

IQ Bot On-Premises version is available for this release with no additional features or updates since the last
release. This version is based on IQ Bot Version 6.5.2 feature and functionality.
IQ Bot feature comparison matrix

IQ Bot On-Premises version is compatible with the corresponding Automation Anywhere Control Room On-
Premises version.
Automation 360 IQ Bot version compatibility on page 745
For a fresh Control Room installation, the user has to upload the IQ Bot package manually. See Add пакеты
to the Control Room on page 2664 for details.
Go to Automation Anywhere support site to download the package:
A-People Downloads page (Login required).

IQ Bot fixed features

The fixed features in this release have not changed since the previous release.
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IQ Bot security fixes

The security fixes in this release have not changed since the previous release.

IQ Bot deprecated features

The deprecated features in this release have not changed since the previous release.

Известные ограничения IQ Bot

There are no new known limitations in this release.

Bot Insight new features in Build 2094

Функция Описание

Visualizations The Visualization widget in the Bot
Insight dashboard provides a host of highly
customizable widgets that you can use to gain
insights on specific scenarios. Vertical and
horizontal Clustered and Stacked bars are
added.
Adding a dashboard widget on page 2991

Bot Insight changed features

The changed features in this release have not changed since the previous release.

Bot Insight fixed features

The fixed features in this release have not changed since the previous release.

Bot Insight deprecated features

The deprecated features in this release have not changed since the previous release.

Известные ограничения Bot Insight

The known limitations in this release have not changed since the previous release.

Enterprise A2019 (Builds 1598 and 1610) Release Notes
These release notes describe new features, changed features, fixed features, security fixes, deprecated
features, and known limitations in Enterprise A2019 (Builds 1598 and 1610).
To verify which  version is compatible with this release, see Compatibility with release builds on page 1033.
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Enterprise A2019 Builds 1598 and 1610

Build 1598 contains updates for the following:
• Enterprise Community Edition
• Bot Insight
• IQ Bot

Build 1610 contains updates for the following:
• On-Premises
• Bot Insight
• IQ Bot

New features in Builds 1598 and 1610

Функция Описание

Pre-migration utility for On-
Premises

The Automation Anywhere pre-migration utility evaluates
your 11.x боты for migration to Enterprise A2019.
Run the pre-migration utility to verify whether your
existing 11.x bots can be migrated to Enterprise A2019.
Use the summary report generated by the utility to
identify the bots that can and cannot be migrated and
decide if you want to start the migration.

Note:  This is an initial version of the pre-migration
utility. We plan to include updates to the utility in
upcoming releases to help migrate most of your bots.

On-Premises Windows installer Enterprise A2019 On-Premises Windows installer is
certified for Azure.

Bot Creator and Bot Runner on
Azure Cloud

Users can create and execute боты for devices on Azure
Cloud.

Action localization Labels, buttons, and tooltips are localized to the
supported language set.

Updated action packages • Additional REST Web Service error codes for better
troubleshooting of API calls

• PGP package for encrypting and decrypting files
• Improvements to SAP actions

Control Room to a SAML-based,
SSO-authenticated Control Room

Enterprise A2019 integrates with SAML identity providers
(IDPs). Post installation, administrators can switch the
Control Room to a SAML-based, SSO-authenticated
Control Room.

Move email messages to different
folder

The Move message command enables the user to move
all the filter-matched emails to a different folder.
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Поддерживаемые пакеты

Пакет Версия

Node Manager 1.0.2110

Приложение 2.0.0-20191128-060339

Логический 2.0.0-20191128-060340

Браузер 2.0.0-20191128-060342

Буфер обмена 2.0.0-20191128-060350

Комментарий 2.0.0-20191128-060351

CSV/TXT 2.0.0-20191128-060352

База данных 2.0.0-20191128-060354

DataTable 2.0.0-20191128-060707

Дата/время 2.0.0-20191128-060358

Задержка 2.1.0-20191128-060359

Словарь 2.0.0-20191128-060400

DLL 2.0.0-20191128-060648

Эл. почта 2.0.0-20191205-100336

Error Handler 2.0.0-20191128-060404

Excel 2.0.0-20191128-060547

Excel_MS 2.0.0-20191128-060434

Файл 2.0.0-20191128-060407

Папка 2.0.0-20191128-060409

FTP/SFTP 2.0.0-20191128-060412

Если/иначе 2.0.0-20191128-060414

IR 2.0.0-20191121-100240

IQ Bot 2.0.0-20191031-150538

JavaScript 2.0.0-20191128-060423

Нажатия клавиш 2.0.0-20191128-060426

Список 2.0.0-20191128-060427

LogToFile 2.0.0-20191128-060428

Цикл 2.0.0-20191128-060429

MessageBox 2.0.0-20191128-060429

Мышь 2.0.0-20191128-060430

Число 2.0.0-20191128-060437

Распознавание текста (OCR) 2.1.0-20191121-100301

PDF 2.1.0-20191128-060540

© 2023 Automation Anywhere. All rights reserved.     625



    Automation Anywhere - Learn

Пакет Версия

PGP 2.1.0-20191129-100500

Ping 2.0.0-20191128-060544

PlaySound 2.0.0-20191128-060545

Запрос 2.0.0-20191128-150505

Python 2.0.0-20191128-060553

Средство записи 1.45.0-20190904-210340

Rest 2.0.0-20191128-060646

SAP 2.1.0-20191128,003143-259

Экран 2.0.0-20191121-100518

SNMP 2.0.0-20191128-060656

Строка 2.0.0-20191128-060704

Система 2.0.0-20191128-150557

Эмулятор терминала 2.0.0-20191128-060711

VBScript 2.0.0-20191121-110553

Ожидать 2.0.0-20191128-060716

Окно 2.0.0-20191128-060718

XML 2.0.0-20191017-030831

Исправленные функции

The fixed features in this release have not changed since the previous release. For a list of these features,
see Enterprise A2019 (Builds 1082 and 1089) Release Notes on page 629.

Исправления в системе безопасности

The security fixes in this release have not changed since the previous release. For a list of these fixes, see
Enterprise A2019 (Builds 1082 and 1089) Release Notes on page 629.

Deprecated features

The deprecated features in this release have not changed since the previous release. For a list of these
deprecations, see Enterprise A2019 (Builds 1082 and 1089) Release Notes on page 629.

Known limitations in Builds 1598 and 1610

• IQ Bot is not supported in Automation Anywhere Cloud and users cannot register any IQ Bot instance
with the Cloud Control Room.

• If a бот is deployed on a device, no other ботs can be deployed on that device until the first бот has
completed the deployed task.
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• When deploying a бот using Unattended Bot Runner on a virtual machine with Windows 10 desktop,
users have to enable remote access to the device (Control Panel > System Properties > Allow
Remote Access).

• Deploying a бот with Bot Runner on a locked device will leave that device in an unlocked state.
• A Bot Creator is not able to view devices as assigned by the Control Room administrator. With this

release, changes to the basic role has removed the View and manage all devices permission so that
unless this permission is expressly granted by the Control Room administrator, the Bot Creator will no
longer be able to see other devices in the Control Room. Bot Creator can register their devices directly;
however, they will not be able to see the other devices in the Control Room.

• Unable to deploy боты from a private workspace using the wizard. Bot Creator can deploy боты from
the editor.

• If users have set up Active Directory for Control Room authentication, changing to SAML or Control
Room Database is not supported.

• Device pool administrators can delete a device pool after automation is scheduled and assigned to the
pool.

• Users without SMTP can still import боты and packages.
• When users delete a бот from the Public workspace, the same бот is deleted from the Private

workspace as well.
• Elastic Search Disaster Recovery backup is not supported.
• Using the Выполнить задачу action with the child task using triggers is not supported.
• User cannot export a бот with dependencies if that user does not have access to any of the related

dependencies.
• Users cannot check out боты if they are linked through circular dependencies.
• Minimizing the window for some Microsoft Active Accessibility apps, such as Notepad, Calculator, or

Remote Desktop Applications, can cause the operation to fail.
• UI Automation, such as Snagit Editor Window for example, will not work in the background unless

expressly minimized.
• UI Triggers are not generating events with Snagit Editor or Inflow app.
• Applications such as calculator use different technologies on Windows 10 vs. Windows 2012 or other

servers. In these cases, when a бот is created in one server configuration, the бот cannot be carried to
another server. User triggers in these cases will not trigger бот deployment and there are no errors in
the trigger listener or node manager logs.

• UI Triggers that are configured with multiple triggers are taking as much as 25 seconds to complete.
• UI Triggers with a single capture and a filter do not work with files larger than 2 MB.
• Button events where a user is switched from one window to a new window of an application fail to

deploy a бот when listening for UI Triggers.
• For Automation Anywhere Elastic Search Service users, the C:\ProgramData

\AutomationAnywhere folder has to be removed before installing Enterprise A2019.
• Users cannot enable SMTP with TLS for the On-Premises version of the Control Room (On-Premises

only).
• User credentials are not editable (On-Premises only).
• Even when a newly added device is registered correctly, the indication icon does not turn green.
• Activity - In Progress table is not cleaning event records until the user performs a hard refresh (F5)

of the browser.
• Domains are not shown for the Device/Run as tab when creating a role. This option is also missing

when running a бот.
• Node manager is not able to establish a handshake SSL connection to the Control Room running on SSL

certificate (On-Premises only).
• Repository Management API is incomplete; there is only one URL in the Swagger file.
• Device pools display completed automations, not scheduled automations.
• If a user is not the device pool administrator, the devices are not correctly displayed when editing a

device pool.
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• For an Unattended Bot Runner, with a device assigned and auto-login credentials set, and Run as self
selected, the Run now option is disabled.

• When a user is running a бот from the Run Wizard and the Bot Agent requires an update, after the
user has updated the agent from the pop-up box, the user cannot deploy the бот until the user
navigates back to the previous page and returns to the workflow to run the wizard.

• Folder triggers do not deploy боты when a folder change event occurs.

IQ Bot Builds 1598 and 1610

IQ Bot On-Premises version is available for this release with no additional features or updates since the last
release.

IQ Bot changed features

IQ Bot is compatible with A2019 Builds 1598 and 1610.

IQ Bot fixed features

The fixed features in this release have not changed since the previous release.

IQ Bot security fixes

The security fixes in this release have not changed since the previous release.

IQ Bot deprecated features

The deprecated features in this release have not changed since the previous release.

Известные ограничения IQ Bot

There are no new known limitations in this release.

Bot Insight new features in Builds 1598 and 1610

Функция Описание

Operation dashboard The Operation dashboard in Bot Insight
displays the Audit dashboard.
You can search for the dashboards using the
Search text box. You can also customize the
dashboards based on your requirements. Role-
based access control and permissions are applied
to the dashboards so that the dashboard shows
data only a specific user is authorized to view.
См. раздел Operations dashboard on page 2975.
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Функция Описание

Analytic visualization widgets The following new widgets are added:
• Stacked Bar Chart
• Clustered Bar Chart

См. раздел Adding a dashboard widget on page
2991.

Bot Insight changed features

The changed features in this release have not changed since the previous release.

Bot Insight fixed features

The fixed features in this release have not changed since the previous release.

Bot Insight deprecated features

The deprecated features in this release have not changed since the previous release.

Известные ограничения Bot Insight

The deprecated features in this release have not changed since the previous release.

Enterprise A2019 (Builds 1082 and 1089) Release Notes
These release notes describe new features, changed features, fixed features, security fixes, deprecated
features, and known limitations in Enterprise A2019.
To verify which  version is compatible with this release, see Compatibility with release builds on page 1033.

Enterprise A2019 Builds 1082 and 1089

Build 1082 contains updates for the following:
• Enterprise Community Edition
• Bot Insight

Build 1089 contains updates for the following:
• On-Premises
• IQ Bot
• Bot Insight
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New features in Builds 1082 and 1089

Функция Описание

Universal recorder support for SAP The universal recorder now supports the SAP graphical
interface for fast and accurate control and ease of editing
generated scripts.

Citrix support Citrix agent enables remote application recording for
object cloning on Citrix servers and leverages ICA to
create user sessions.

Enhanced code editing Select multiple lines of code in editor to copy, move,
disable, enable, as well as disable/enable a line of an
action in a бот script.
Users can run боты from a particular line of code or
action inside the бот.

Бот import and export Users can export боты with dependencies into a common
zip file, including all actions. Users can manually exclude
пакеты from the export process.
All imported action пакеты will be automatically installed
into the target Cloud Control Room and the ботs placed
inside the user private workspace.

Фоновая обработка Background processing for Citrix Virtual Apps and
Windows native applications. Excel пакеты inherently
support background processes.

REST пакет Support for GET, POST (text, XML, and HTML), PUT, and
DELETE methods. Authentication types supported include
Basic, Logged-in AD user, and NTLM.

OCR Action Users can capture window and capture image by path.

Active Directory integration for On-
Premises

Allowing auto-discovery of sites and domains, Enterprise
A2019 On-Premises integrates Active Directory to support
multi-domain as well as multi-forest deployments.

Поддерживаемые пакеты

Пакет Версия

Node Manager 1.0.1745

Приложение 2.0.0-20191016,213334-22

Логический 2.0.0-20191017-030403

Браузер 2.0.0-20191017-030404

Буфер обмена 2.0.0-20191016,213334-16

Комментарий 2.0.0-20191017-030408

CSV/TXT 2.0.0-20191017-030409
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Пакет Версия

База данных 2.0.0-20191017-030411

DataTable 2.0.0-20191029,062940-3

Дата/время 2.0.0-20191017-030416

Задержка 2.1.0-20191017-030417

Словарь 2.0.0-20191017-140648

DLL 2.0.0-20191031-100332

Эл. почта 2.0.0-20191024-120209

Error Handler 2.0.0-20191031-100110

Excel 2.0.0-20191024-160417

Excel_MS 2.0.0-20191101-120011

Файл 2.0.0-20191017-140654

Папка 2.0.0-20191017-140657

FTP/SFTP 2.0.0-20191023-181858

Если/иначе 2.0.0-20191017-030432

IR 1.0.0-20190923-115359

IQ Bot 2.0.0-20191031-150538

JavaScript 2.0.0-20191031-100128

Нажатия клавиш 2.0.0-20191018-100419

Список 2.0.0-20191017-030447

LogToFile 2.0.0-20191017-030447

Цикл 2.0.0-20191017-030449

MessageBox 2.0.0-20191017-030449

Мышь 2.0.0-20191017-030450

Число 2.0.0-20191029-100152

Распознавание текста (OCR) 2.1.0-20191017-030626

PDF 2.1.0-20191017-030713

Ping 2.0.0-20191017-030715

PlaySound 2.0.0-20191024-160415

Запрос 2.0.0-20191024-160423

Python 2.0.0-20191031-100238

Средство записи 1.45.0-20190904-210340

Rest 2.0.0-20191024-090501

SAP 2.1.0-20191031-100334

Экран 2.0.0-20191017-030809
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Пакет Версия

SNMP 2.0.0-20191023-181621

Строка 2.0.0-20191025-221016

Эмулятор терминала 2.0.0-20191023-181907

VBScript 2.0.0-20191031-100352

Ожидать 2.0.0-20191017-030828

Окно 2.0.0-20191017-030829

XML 2.0.0-20191017-030831

Измененные функции

Измененные функции

TaskBot All rich features of MetaBot, such as DLL and
code protection using execute permission,
are now part of a standard TaskBot. This also
includes inline scripting using Python, VBScripts,
and more to help reduce the learning curve
for new users and provides a uniform bot
development experience.

Исправленные функции

The fixed features in this release have not changed since the previous release. For a list of these features,
see Enterprise A2019 (Build 550) Release Notes on page 636.

Исправления в системе безопасности

The security fixes in this release have not changed since the previous release. For a list of these fixes, see
Enterprise A2019 (Build 550) Release Notes on page 636.

Deprecated features

The deprecated features in this release have not changed since the previous release. For a list of these
deprecations, see Enterprise A2019 (Build 550) Release Notes on page 636.

Known limitations in Builds 1082 and 1089

• IQ Bot is not supported in Automation Anywhere Cloud and users cannot register any IQ Bot instance
with Cloud Control Room.

• To create database tables in Cloud Control Room where internet access is restricted and deploying
Liquibase, users are required to unblock the Java process to connect to www.liquibase.org in order to
download the schema and allow java.exe to have internet access.

© 2023 Automation Anywhere. All rights reserved.     632

http://www.liquibase.org


    Automation Anywhere - Learn

• The Folder trigger has the following event options: create, modify, and delete. The File trigger only
has the modify and delete event options.

• A бот cannot have duplicate Triggers that point to the same directory.
• Using the action Run Task with the child task using triggers is not supported.
• Activity - In Progress is not cleaning the event record until user does hard refresh (F5) of the browser.
• User cannot export a бот with dependencies if that user does not have access to any of the related

dependencies.
• Users cannot checkout боты if they are linked via circular dependencies.
• Minimizing the window for some Microsoft Active Accessibility apps, such as Notepad, Calculator, or

Remote Desktop Applications, can cause the operation to fail.
• UI Automation, such as Snagit Editor Window for example, will not work in the background unless

expressly minimized.
• If the system Citrix plugin is not updated, the Recorder will not launch.
• If the user renames a previously saved recorder бот, a download error is generated and results in loss

of images.
• For Elasticsearch users, remove the C:\ProgramData\AutomationAnywhere folder prior to

installing Enterprise A2019.
• Users cannot enable SMTP with TLS for the on-premises version of the Control Room (On-Premises

only).
• User credentials are not editable (On-Premises only).
• Installer fails to create credentials using Windows Authentication. Use SQL Authentication service

credentials (On-Premises only).
• In an On-Premises environment, creating credentials with the Credential Vault is not supported in this

release.
• When using the Recorder with Citrix in an On-Premises deployment, the Citrix Agent could generate an

internal server error during the recording process.

IQ Bot Builds 1082 and 1089

IQ Bot Community Edition is available for this release. IQ Bot is not yet available on Automation Anywhere
Cloud.
См. раздел Краткое руководство пользователя по IQ Bot Community Edition.

IQ Bot changed features

IQ Bot is compatible with Enterprise A2019 Build 1089.

IQ Bot fixed features

The fixed features in this release have not changed since the previous release.

IQ Bot security fixes

The security fixes in this release have not changed since the previous release.
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IQ Bot deprecated features

The deprecated features in this release have not changed since the previous release.

Известные ограничения IQ Bot

For On-Premises, if IQ Bot and Control Room are installed on the same machine, on restarting the
machine, IQ Bot does not work, and displays an error message.

Note:  We recommend restarting Automation Anywhere Control Room Reverse Proxy service to resolve
the issue.

Bot Insight new features in Builds 1082 and 1089

Функция Описание

Smart data profiling for country, state, and
zip codes

Bot Insight analyzes information provided in the
variables to automatically identify information
based on the country, state, and zip or postal
code. You can use this information to create the
World and US Map widgets.
См. раздел Editing a data profile on page 2981.

Business data delete API Use this API to delete logged data from either
the production mode or the development mode
for a particular Control Room instance.
DELETE <control_room_url>/
v2/botinsight/data/api/
deletetasklogdata.

Business data profile API Use this API to extract the business
data profile logged in Bot Insight.GET
 <control_room_URL>/v2/botinsight/
data/api/gettaskvariableprofile

Business data API Use this API to extract the business data logged
in Bot Insight.
GET https://{{ControlRoomURL}}/v2/
botinsight/data/api/gettasklogdata?
botname=<botname>

Resize dashboard widgets You can resize and save the widgets in the Bot
Insight dashboard based on your requirements.
When you resize a dashboard widget, other
widgets in the dashboard are automatically
adjusted to fill in the available layout.
См. раздел Editing a dashboard widget on page
2994.
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Функция Описание

US map widget The US Map widget enables you to visualize and
analyze information about Country, State, City,
and Zip Code.
См. раздел Adding a dashboard widget on page
2991.

World map widget The World Map widget enables you to visualize
and analyze information about Country, State,
Zip Code, Latitude, and Longitude.
См. раздел Adding a dashboard widget on page
2991.

Parent child dashboard When you create a new бот, Bot Insight
automatically creates a default dashboard. If you
have a parent бот and a child бот, Bot Insight
creates a separate dashboard for each of the
ботs.
См. раздел Информационные панели Bot
Insight on page 2972.

Notification of variable updates in the
standard dashboard

Data profile updates are highlighted with a red
dot in the standard dashboard.
См. раздел Customizing a dashboard on page
2985.

Data logging When you deploy and run a бот on the Bot
Runner machine, Bot Insight aggregates all the
information about that бот. Опубликованная
информационная панель этого бот
отображает агрегированную информацию
бот.
См. раздел Информационные панели Bot
Insight on page 2972.

Bot Insight The Analyze package provides the following
functions to enable business analytics in the Bot
Insight dashboard:
• Analyze Open
• Analyze Close

Bot Insight changed features

The changed features in this release have not changed since the previous release.

Bot Insight fixed features

The fixed features in this release have not changed since the previous release.
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Bot Insight deprecated features

The deprecated features in this release have not changed since the previous release.

Известные ограничения Bot Insight

The known limitations in this release have not changed since the previous release.

Enterprise A2019 (Build 550) Release Notes
These release notes describe new features, changed features, fixed features, security fixes, deprecated
features, and known limitations in Enterprise A2019 (Build 550).

New features in A2019 Build 550

Функция Описание

On-premises installer The on-premises installation application for Enterprise
A2019.

IQ Bot supports IE11 IQ Bot (Build 550) supports Internet Explorer version 11
(IE11).

Download all documents action Use the Download all documents action to download
the extracted results from an IQ Bot server that was
created by running a TaskBot, using the Upload
Document action.

Supported packages in Build 550

The supported packages in this release have not changed since the previous release. For a list of these
packages, see Enterprise A2019 (Build 543) Release Notes on page 637.

Измененные функции

IQ Bot (Build 550) Changed Features

Проблема Описание

Language toggle UI redesigned On the IQ Bot landing page, user can click the
language toggle at the top right corner, to select
a language from the drop-down list. The UI
displays in the selected language.
User can select a language from either the
Control Room or IQ Bot language toggle icon.

Note:  After logging out of the system, the
system performs a reset. This requires the user
to select the language again at login.
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IQ Bot (Build 550) Changed Features

Проблема Описание

Upload document action The Upload document action lets you to
upload documents for processing with IQ Bot,
using a TaskBot.

Исправленные функции

IQ Bot (Build 550) fixed features:
• Japanese documents using Microsoft Azure Computer Vision OCR engine get classified correctly.
• In the Designer window, during document training, user is able to move from one page to the other

successfully along with mapping of form and table fields.
• Download API can download successfully processed documents after moving the бот and learning

instance to production.

Исправления в системе безопасности

No security features are introduced in this build.

Deprecated features

No deprecated features are introduced in this build.

Известные ограничения

IQ Bot (Build 550) known limitations:
• When using Internet Explorer (IE) 11, icons disappear after a page refresh. A hard refresh (Ctrl plus F5)

helps fix the issue.
• When using Internet Explorer (IE) 11, if user imports a domain, the system shows an error message.

However, the feature works as expected.
• User is unable to migrate IQBA files from other versions of IQ Bot.
• IQ Bot portal does not launch after a machine restart. User has to restart Automation Anywhere Control

Room Reverse Proxy Service as well.

Enterprise A2019 (Build 543) Release Notes
These release notes describe new features, changed features, fixed features, security fixes, deprecated
features, and known limitations in Enterprise A2019 (Build 543).
To verify which  version is compatible with this release, see Compatibility with release builds on page 1033.
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New features in A2019 Build 543

Функция Описание

Next generation бот workbench Create bots from any device, from anywhere through
a web browser. The intuitive new design for applying
multiple personas with varying bot building skills
and a redesigned work area for simple assembly and
deployment. These include:
• A universal recorder to simplify capturing processes
• List and Flow views for TaskBot creation
• Powerful бот code management capabilities
• Rich variable passing with no cross-language mapping

required

Bot Runner Access and run боты from the cloud. When ботs are
deployed to Bot Runners, any dependent actions are also
deployed. When updates to Actions are available, the
updates are also automatically pushed.

Package manager The package manager centralizes control over bundled
actions to enable users to deploy and upgrade only those
targeted actions being used.

Advanced variable types Access expanded variables and array types for enhanced
action implementation, including DateTime, numbers, list,
Boolean, dictionary, multi-dimension arrays for reading
Microsoft Excel documents, and file data column for .CSV
files.

Inline scripting Native support for Python and VBScript inline scripting
languages enables simple data passing between scripts
and bots.

New UX The new user experience provides assistance for users
who are getting started and includes step-by-step
guidance for common tasks.

Excel automation Configure Microsoft Excel TaskBot automation without
installing Microsoft Office on the Bot Runner machine.

Recording of automation Record automation, even from a remote device.

IQ Bot Enterprise A2019 will fully support IQ Bot, the only AI-
driven solution for users to automate processing of
complex documents.

Bot Insight The Analyze package provides the following functions to
enable business analytics in the Bot Insight dashboard:
• Analyze Open
• Analyze Close

© 2023 Automation Anywhere. All rights reserved.     638



    Automation Anywhere - Learn

Table 1: Supported packages in Build 543

Пакет Версия

Node Manager 1.0.1221

Приложение 1.0.0-20190919,040305-1231

Логический 1.0.0-20190919,040305-1435

Браузер 1.0.0-20190919,040305-1287

Буфер обмена 1.1.0-20190919,040305-1492

Комментарий 1.0.0-20190919,040305-633

CSV/TXT 1.2.0-20190919,040305-1349

База данных 1.1.0-20190919,040305-1287

Дата/время 1.0.0-20190919,040305-1189

Задержка 1.1.0-20190919,040305-1492

Словарь 1.0.0-20190919,040305-1337

DLL 1.0.0-20190920,070246-677

Эл. почта 1.0.0-20190919.040305

Error Handler 1.0.0-20190919,040305-1333

Excel 1.1.0-20190921,042722-1353

Excel_MS 1.0.0-20190921,042722-1309

Файл 1.0.0-20190919,040305-1382

Папка 1.0.0-20190919,040305-1337

FTP/SFTP 1.0.0-20190919,040305-660

Если/иначе 1.0.0-20190919,040305-1375

IR 1.0.0-20190923,062209-1140

IQ Bot 2.0.0-20191031-150538

JavaScript 1.1.0-20190919,040305-989

Keystroke 1.1.0-20190919,040305-1492

Список 1.0.0-20190919,040305-1466

Log to File 1.1.0-20190919,040305-1456

Цикл 1.0.0-20190919,040305-1466

Message Box 1.1.0-20190919,040305-1492

Мышь 1.1.0-20190919,040305-1492

Число 1.0.0-20190919,040305-1148

PDF 1.1.0-20190919,040305-1492

Ping 1.0.0-20190919,040305-1319

PlaySound 1.0.0-20190919,054049-118
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Пакет Версия

Запрос 1.1.0-20190919,040305-1180

Python 1.3.0-20190919,040305-1287

Средство записи 1.45.0-20190904,153347-191

RunTask 1.1.0-20190701,181500-763

SAP 1.1.0-20190923,152217-493

Экран 1.0.0-20190919,040305-1105

SNMP 1.0.0-20190919,040305-359

Шаг 1.0.0-20190701,181442-695

Строка 1.1.0-20190919,040305-1469

Таблица 1.0.0-20190919,040305-719

VBScript 1.1.0-20190919,040305-1334

Ожидать 1.0.0-20190919,040305-1287

Окно 1.0.0-20190919,040305-1333

XML 1.0.0-20190919,040305-717

Измененные функции

This build does not include any changed features.

Исправленные функции

No fixed features are introduced in this build.

Исправления в системе безопасности

No security fixes are introduced in this build.

Deprecated features

No deprecated features are introduced in this build.

Известные ограничения

Функция Limitation description

Средство записи .NET Framework 4.6.1 is required for the
Recorder package.

Бот agent Users of build 543 are required to download and
install the latest agent.
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Функция Limitation description

Bot Insight Bot Insight has the following limitations:
• Bot Insight dashboard does not support Drag

and Drop to move and arrange the dashboard
widgets within the dashboard.

• The Date widget in the dashboard displays
the Unix time stamp.

• Bot Insight does not support the Aggregate
By feature in the Table widget, if the table
contains a Timestamp.

• Once the bots run successfully, the default
dashboard is generated after 5 to 10 seconds.

Community Edition — заметки о выпуске
Ознакомьтесь с новыми возможностями в различных выпусках Community Edition Automation 360.

Important:  Enterprise A2019 теперь называется Automation 360. Хотя в заметках о выпуске для
выпусков более ранних версий, чем Automation 360 v.21, упоминается старое название продукта,
содержимое этих заметок применимо и актуально для Automation 360.

Note:  Подробную информацию об исправлении Automation 360 v.24R2 для Community Edition см. в
разделе «Заметки о выпуске Automation 360 v.24R2 для прекращения поддержки Internet Explorer 11 on
page 263».

Чтобы просмотреть обновления заметок о выпуске для соответствующего выпуска, перейдите по
ссылкам.
Related concepts
Automation 360 — заметки о выпуске on page 65
Review the new capabilities, changes, fixes (resolved issues), security fixes, deprecated features, and
limitations in each release.

Заметки Community Edition о выпуске Automation 360 v.28
Дата выпуска: 22 March 2023

Просмотрите в Community Edition новые возможности выпуска Automation 360 v.28 (Сборка 17464).

Important:  Этот выпуск включает в себя необязательное обновление Bot Agent. You can continue
to run your existing боты without updating the Bot Agent. However, if you want to use the new features in
Automation 360 v.28, you must update the Bot Agent available with this release.
Более подробную информацию об обновлении до этого выпуска см. на указанных ниже ресурсах.
• Автоматическое обновление Bot Agent on page 1049 | Обновление Bot Agent вручную on page 1050
• Compatibility with release builds on page 1033
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Рабочая область RPA

Новые возможности

Workday пакет
You can use the new Workday package from Automation 360 to automate your Workday processes
such as reporting, data upload/download, or triggering workflows with our new point-and-click
experience. The package provides deep API-level integration with Workday that enables you to
build automations easily, without having to code.

Apigee пакет
You can use the new Disconnect and Resume Integration features in the Apigee package. You can
disconnect from your Apigee instance and clear the session using the Apigee Disconnect action. You
can resume an integration that is suspended in Apigee using the Apigee Resume Integration action.

Extended attributes supported in the Эмулятор терминала Пакет (Service Cloud case ID:
01870633, 01928396, 01809815)
The TN3270E terminal type supports extended attributes. To enable extended attributes for
TN3270E terminals, select the Extended Attribute check box in the Connect action.

Enhanced error messages display errors from the child bots (Service Cloud case ID:
01264352)
When you create a бот where the parent бот calls a child бот, and if an error occurs in the child
бот, the error message provides the following details:
• Line number of the parent бот which ran the child бот.
• Line number of the child бот where the error occurred.
• Error message details, such as what went wrong with that line number and the corresponding

corrective action.

Timeout option in Database Connect action (Service Cloud case ID: 00753858)
We added a timeout option in the Connect action of the База данных Пакет. When you connect
with Microsoft SQL Server to automate database-related tasks, and if the database is down or
experiences any network issues, the automation will time out and fail if the database connection is
not established in the specified time.

Improved readability with new formatting capabilities in XML document (Service Cloud
case ID: 01886455, 01925386)
When you insert, update, or delete nodes, the XML пакет does not remove carriage return
characters between nodes but does remove all blank text nodes from the XML document. By using
Prettyprint to format XML files, developers can easily improve the readability of a document.
Developers can save time by using the following new options that have been added to the XML
Пакет:
• Use Prettyprint: The Save session data action supports the Prettyprint format in the XML

document. When you select the Use Prettyprint check box and use the Insert node, Update
node, or Delete node actions and then save the XML document, the code is formatted with
proper indentation as per Prettyprint.

• Remove text nodes that contain only white space: The Start Session action provides an
option to remove blank text nodes when you parse the XML document.
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Новые возможности

New features added to the Эл. почта Пакет (Service Cloud case ID: 01835214, 01846425,
01756713, 01882482)
To support extensive process automation, we added the following action-related features to the Эл.
почта Пакет:
• Ability to use the Reply All action.
• Enhanced the Delete all action to delete all emails from a specific folder. Additionally, you can

apply filter parameters to emails such as:
• All, Read, and Unread
• Тема
• From a specific sender
• Before, on, or after a received date

• The dictionary variable for email properties includes a new variable, emailNoOfAttachments, used
to retrieve the attachment count.

Automate controls using Microsoft UI Automation (COM) technology
You can use the Microsoft UI Automation (COM) technology to automate the following scenarios:
• Capture and automate link controls
• Capture and automate tree controls

Insert Custom column in Таблица данных
A new Custom column option has been added to the Data Table > Insert column action that
enables you to insert a new column at a specified index in a data table. When you read an Excel
spreadsheet and assign it to a data table, you can modify the table by adding a new column and
entering any required data.

New Label option in Цикл пакет
A new Label option has been added to the Цикл пакет that enables you to break or continue a
specific loop from the nested loops.

Add and configure If action conditions
You can add and configure a maximum of 32 conditions in a single If action.

Improved automation reliability for web applications
When you use the Recorder > Capture action to automate web pages running on Google Chrome
and Microsoft Edge browsers, the Recorder > Capture action no longer scrolls down the web
page if the target object is visible on the screen. By having a fixed top pane on the web page, the
user experience and automation reliability are improved particularly if some physical actions (such
as mouse clicks) do not work as expected.

Note:  Ensure that you install the browser extension (version 3.0.8.0) and use the Средство
записи пакет (version 2.10.2) to capture the control.
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Новые возможности

Preferred view retained as default view in the Bot editor
As a бот developer, you no longer have to manually select the preferred view when you open the
Bot editor. To improve the developer's productivity and user experience, when creating боты in
the Bot editor, your preferred view (List, Flow, or Dual) in the Bot editor will persist across user
sessions and browsers. When you navigate in the Control Room or after your next log in, the Bot
editor will retain your last used or selected view.

Line markers for collapsible sections of code in the Bot editor
When you create боты using Loop, If/If-else, Step, Trigger-loop, Try, Catch, and Finally
statements, the Bot editor clearly shows the collapsible sections. When building automations,
developers can use these visual indicator line markers at the beginning and end of the collapsible
section to improve their productivity.

Note:  The visual indicator line marker for the collapsible section applies only to the List view in
the Bot editor.

Изменения

Improved secure registration for Community Edition or Automation 360 users
When a user registers for the Community Edition or Automation 360 account, the registration email
sent to the user contains a temporary registration link used to create the user credentials. This
registration method is more secure than sending the user their password in plain text.

Automation Anywhere Robotic Interface (AARI)

Новые возможности

Stationary action buttons
While completing forms in AARI, action buttons are positioned in the fixed footer of the form. The
footer and its contents are responsive to the size of your window and adjust to fit buttons and
minimize the footprint.

Forms have improved responsiveness due to this next generation of form rendering technology.

Document Automation

Изменения

Important:  New Community Edition users will have access to Document Automation
but not IQ Bot
As of Automation 360 v.27 release and later, only Document Automation will be provisioned to new
Community Edition users. New users will not have IQ Bot permissions, however, IQ Bot will be
available for existing, registered users.
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Заметки Community Edition о выпуске Automation 360 v.27
Дата выпуска: 15 декабря 2022 года
Просмотрите в Community Edition новые возможности выпуска Automation 360 v.27 (Сборка 16701).
Сборка 16701 replaces Build 16667.

Прим.:  Этот выпуск включает в себя необязательное обновление Bot Agent. You can continue to
run your existing боты without updating the Bot Agent. However, if you want to use the new features in
Automation 360 v.27, you must update the Bot Agent available with this release.
Более подробную информацию об обновлении до этого выпуска см. на указанных ниже ресурсах.
• Автоматическое обновление Bot Agent | Обновление Bot Agent вручную
• Compatibility with release builds

Updated release build

The updated Сборка 16701 includes fixes for the following issues (Service Cloud case ID: 01937106,
01947340, 01829572):
• Боты were failing because of file dependency or interactive form that included multibyte characters in

file names.
• Changes to AARI desktop Assistant to manage and clear automations for start, stop, and resume

actions.

Рабочая область RPA

Новые возможности

Windows 365 Cloud PC now supported as Bot Runner (Service Cloud case ID: 01792699)
We support Windows 365 Cloud PC as a Bot Runner to create and run боты on Windows 365 Cloud
PC.
Automation 360 Bot Runner device requirements

View keyboard shortcuts in Bot editor
In Bot editor, you can now open a menu to view the available keyboard shortcuts.
Keyboard shortcuts

Enhanced Automation Anywhere Debugger tool
The Automation Anywhere Debugger tool is available in the Bot Assistant utility to provide a
better user experience. When you invoke the Debugger tool from the Bot editor, you can add,
update, or delete actions and variables in a бот.
By default, the Watched variables lists is empty. With a single click, you can add all the used
variables in a бот. These variables display in a pop-up window where you can select or deselect,
one or more variables, from the list.
Debugger tool
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Новые возможности

ServiceNow пакет
You can use the ServiceNow package from Automation 360 to authenticate and perform several
actions with records and attachments in ServiceNow tables.
ServiceNow пакет

ServiceNow triggers
You can use ServiceNow triggers to call an action when there is a new or updated record.
ServiceNow New Record trigger

Quick assistance at hand for the developers in the Bot editor
The accessibility and usability of the Bot editor, actions, and пакеты have been improved. As
a citizen developer or an RPA developer, when you are creating боты, you can quickly look up
information about the actions without navigating outside the Bot editor. Under the Actions pane,
quick help is enabled with contextual information about actions. Additionally, an icon is configured
with a link to the documentation. If you want more information about an action, you can click the
link, which redirects you to the relevant page in the documentation portal. This feature is currently
available in the following actions and пакеты.
• База данных
• Эл. почта

Enhanced user experience through refreshed and intuitive icons
With the new and intuitive icons for actions in the Bot editor, citizen developers and RPA developers
can quickly locate the correct action while creating automation for a day-to-day task. These unique
and renewed icons are developed according to brand and global standards.

New option in Read from action of База данных пакет (Service Cloud case ID: 01263940)
A new check box is available when you use the Read from action to retrieve records from the
database and save the retrieved data in a CSV file. When you select this check box, no CSV file is
created if the executed SQL query does not return any data.

64-bit ODBC driver now supported in База данных пакет (Service Cloud case ID:
01256142, 01829360, 01849908)
We now support connecting to databases by using the 64-bit ODBC driver. This option is available
when the connection mode is the default. Organizations transitioning to Office 365 will benefit from
leveraging this enhancement and can sustain automation build with 32-bit ODBC drivers.

Использование action «Подключить» для базы данных
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Новые возможности

OAuth 2.0 support in Эл. почта and Email trigger пакеты (Service Cloud case ID:
01798311, 01803702, 01791859, 01828526)
Microsoft is deprecating the ability to use Basic authentication in Exchange Online for these specific
protocols:
• IMAP
• POP3
• EWS

We support OAuth 2.0 authentication for these protocols in the Эл. почта and Email trigger
пакеты. For enhanced security, you can maintain the business continuity of your email automations
by switching the authentication type from Basic to OAuth 2.0, (as recommended by Microsoft).
Using Connect action for Эл. почта

Retry mechanism supported in credential variables (Service Cloud case ID: 01786319,
01887182)
The credential variables support the retry mechanism. When you create a бот that uses credential
variables, if the бот fails during run time to retrieve those variables from the Credential Vault
because the Control Room is disconnected or the Control Room services stop intermittently, then
the бот tries three times to retrieve the credential variables from the Credential Vault.

Прим.:  Ensure that the Bot Agent version installed on your system is the version that is released
with Automation 360 v.27.
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Новые возможности

Support of other domain name in the Active Directory пакет (Service Cloud case ID:
01807358, 01910765)
We now support Active Directory user operations by logon name with domain and can provide the
domain name to extract user details. When you retrieve the user property or perform any user
operation based on the logon name (userPrincipalName), and if the user domain name differs from
the domain specified in the LDAP path, the user properties are now successfully retrieved with or
without a domain name.
For example, LDAP Path: LDAP://ADServer/DC=automation, DC=net

Пользователь Имя входа

userPrincipalName: kim@aaengg.net User can provide logon name as
kim@aaengg.net.

userPrincipalName: shaun@aasales.net User can provide logon name as
shaun@aasales.net.

userPrincipalName:sarah@automation.net user can provide a logon name as either sarah
or sarah@automation.net.

The following list of actions supports logon name with domain.
• Обновить сведения о пользователе
• Переименовать пользователя
• Удалить пользователя
• Включить учётную запись пользователя
• Отключить учётную запись пользователя
• Установить свойство пользователя
• Получить свойство пользователя

User account operations

Новое action в пакет Текстовый файл
You can use the new Read variables action in the Текстовый файл пакет to read the values of
variables from the text file.

Прим.:  The Import string from text file action in the Строка пакет has been deprecated and
will not be available for new боты. We recommend that you use the new Read variables action
with enhanced capabilities. This deprecation does not impact any existing боты or боты which were
migrated previously and they will continue to run properly. See Support and deprecation policy for
пакеты for пакет lifecycle and deprecation policy.

Read variables action

Call an existing JavaScript function in a webpage
You can use the new Call a JavaScript function action in the Браузер пакет to call an existing
JavaScript function directly in a webpage or in an iFrame within a webpage in Google Chrome
and Chromium-based Microsoft Edge browsers. In the бот, you can also pass one or more input
parameters to the JavaScript function and process the return value from the function.
Call a JavaScript function action
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Новые возможности

Automate controls using Microsoft UI Automation (COM) technology
You can use the Microsoft UI Automation (COM) technology to automate the following scenarios:
• Capture and automate client controls
• Capture and automate password text controls
• Capture and automate page tab controls

Actions performed on objects captured with Universal Recorder | Capture using specific technology

Capture objects on applications running in administrator mode
You can use the Средство записи to capture objects on applications running in administrator mode.
To capture the object, select the Capture and run with admin privileges option from the Bot
editor.

Пакет Средство записи

Enhanced бот performance when using global values across боты
When you use global values across a parent бот and a child бот, the бот performance is enhanced
by reducing the бот execution time. To enable enhanced бот performance, you must set the Bot
compatibility version to 3 in the Advanced settings page of the Bot editor.

Прим.:  Ensure that the Bot Agent version installed on your system is the version that is released
with Automation 360 v.27.

Версия совместимости Бот

Enhanced user interface for Define functionality in AISense Recorder
• We have enhanced the user interface of Define window in the AISense Recorder that enables

you to use anchors easily and automate UI objects that are not detected by AISense Recorder
automatically. To improve functional clarity, the following object types are renamed:
• Active text is renamed to Link
• Passive text is renamed to Text value

• If you unintentionally click the screen or click before the highlighter appears, the AISense
Recorder provides visibility into it. You must confirm to capture the object again or use the
Define functionality to define the object on the screen.

• In the Define window, the AISense Recorder shows embedded help for each of the control
types so you can select the correct control types for custom objects.

Use variable anchor | Capture Textbox, Radio, Checkbox, and Combobox | Capture text value through
AISense Recorder | Capture link button through AISense Recorder | Capture Image button through AISense
Recorder

New virtual key added to the Имитация нажатия клавиш package
In the Simulate Keystrokes > Keystrokes action, a new key named Return has been added
to the virtual keyboard for Enter functionality and the Enter key in the Number pad has been
renamed to Num Enter. As a result, the Return key is the main Enter key on the keyboard. This
enhancement keeps the keyboard in sync with the physical keyboard. The nomenclature has been
changed to avoid confusion between the Enter key on the keyboard and the Enter key on the
Number pad.
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Новые возможности

Support for global variable for all Datetime actions
In the Дата/время package, you can use the Datetime global variable across all Datetime actions.
You can select to use either String variable or a Global variable in the Source date and time
variable option. This avoids creating multiple local variables and reduces the total number of
actions used in a бот.
Datetime пакет

Workato Integration
You can integrate the Automation 360 platform and Workato by using the Automation Anywhere
connector. You can establish a connection with the Automation Anywhere Control Room and
perform various operations using the Control Room APIs.
Workato integration

SnapLogic Integration
You can now integrate the Automation 360 platform and SnapLogic. You can establish a connection
with the Automation Anywhere Control Room and perform various operations by using the Control
Room APIs.
Snaplogic integration

Automation Anywhere Robotic Interface (AARI)

Новые возможности

Build forms easily by dragging elements to form builder
You can now build your forms by just dragging your elements to a blank form builder. As you add
elements to the form builder, it automatically adjusts without your input, letting you focus on the
form-building experience. You can also re-size the columns of your elements.
Create a form

New actions in the Process Composer
In the Process Composer, you can now use a set of actions when you build out your process. For
example, you can double-click a task, such as Bot Task and Human Task, and the task will be
updated in your process flow automatically. With this, you can save time because you do not need
to task specific tasks to your process. In addition, you can now copy, cut, and paste using CTRL +
C, CTRL + X and CTRL + V, respectively to retain, reuse, or replace data.
Behaviors supported in the Process Composer | Создание процесса AARI

Use a reference ID meta type in Process Composer
You can now use a reference ID with a Meta variable type for your variables in the Process
Composer. When you set a reference ID as a meta variable type, you can now use your reference
ID data when you run your tasks in the web interface. This simplifies your references because you
only need to rely on using the reference ID instead of relying on other variable types or references.

Создание процесса AARI
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Новые возможности

Center your forms in preview
You can now preview your forms in the new preview window and get an accurate assessment on
how your form will look when it is rendered. You can select the Make form preview centered
option to enable the preview window. You can also set the appropriate display resolution, x and y
coordinates, and even center your form.
Create a form

Upload images directly to the form composer
You can now upload images directly to the form composer by using the Image element. This saves
you time to view the images in the form without a file reference, rather than in the initial step,
where the image requires a file reference to be viewed.

Прим.:  Image files are limited to 150 kb (like a logo).

Using the Image element

Change label action for Button element
The change label action in the form rules now applies to the Button element. When you use the
change label action in form rules and apply it to the buttons in your form, the changes will be
automatically applied to the buttons where you set the rules. This keeps the flow consistent with
the elements that you are using because all the buttons inherit the same rule.

Добавление правил к элементам формы

Rules editor for Table element
The rules editor is now applicable to the Table element. When you use the rules editor for your
tables, the rules conditions are applied for each individual columns while any actions that you set
are applied for each row in the row level. This makes things consistent for each new or existing row
that you use because all the rows inherit the same rule.

Добавление правил к элементам формы

Document Automation

Новые возможности

Document Automation supports regular expression pattern-based extraction
When configuring fields that the learning instance will extract, you can specify a regular expression
(regex) pattern to help the extraction engine find the field. After entering the regex pattern you can
test the expression using sample content within the Create Learning instance window. You can
use regex pattern extraction for values that follow a specific pattern, such as a VAT number or a PO
number.

Validation interface support for shortcut keys
Zoom in and out on documents in the Validation interface by holding the Alt key and scrolling with
your mouse wheel.
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Automation 360 v.26 Community Edition Release Notes
Release date: 22 September 2022

Review what's new in the Community Edition of the Automation 360 v.26 (Build 15450) release. Build
15450 replaces Build 15439.

Note:  The v.26 build supports Manifest V3 browser extensions for Google Chrome and Microsoft Edge
browsers. For more information, see Chrome and Edge Manifest V3 extensions on page 812.

Bot agent update:  This release includes an optional Bot Agent update. You can continue to run your
existing боты without updating the Bot Agent. However, if you want to use the new features in Automation
360 v.26, you must update the Bot Agent available with this release.
For more information on updating to this release, see these resources:
• Автоматическое обновление Bot Agent on page 1049 | Обновление Bot Agent вручную on page 1050
• Compatibility with release builds on page 1033

Рабочая область RPA

What's new

Community Edition users provisioned to closest region
Registered Community Edition users are now provisioned to a region that is closest to their country
(either in the US or EU). Provisioning is based on the country of the users account.

Support for Manifest V3 extensions
Automations that use Google Chrome Manifest V2 based extensions will stop working sometime
after June 2023. The deprecation timelines of Manifest V2 based extensions are currently under
review and subject to change by Google.
• For Google Chrome Manifest V2 extensions timelines, see Manifest V2 support timeline.
• For Microsoft Edge Manifest V2 extensions timelines, see Overview and timelines for migrating to

Manifest V3.

This might impact your existing automations that use Manifest V2 based extensions for Google
Chrome and Microsoft Edge browsers. Automation 360 v.26 and later includes Manifest V3
extensions by default to support features that use Google Chrome and Microsoft Edge browsers.
You can automatically enable Manifest V3 based extensions for Google Chrome and Microsoft Edge
on all the Bot Runner devices by enabling the Browser extensions option from the Control Room.
Enabling this option applies the browser extension settings on all the registered Bot Agent devices.

Note:  We will continue to support Manifest V2 based extensions for Google Chrome until June
2023. To know about Microsoft Edge Manifest V2 based extensions timelines, see Overview and
timelines for migrating to Manifest V3.

Note:  Manifest V3 extension is supported on Google Chrome and Microsoft Edge browsers version
91 and later only.

Configure browser extensions on page 2743 | Chrome and Edge Manifest V3 extensions on page 812
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What's new

Microsoft Windows 11 Enterprise now supported (Service Cloud case ID: 01252605,
1252605, 1253745, 01255134, 01379865, 01801610, 01810148)
We now support Microsoft Windows 11 Enterprise, so you can now install and update the Bot Agent
and run боты on the Windows 11 Enterprise operating system.

Совместимость Bot Agent on page 1032

Salesforce command пакет
You can now authenticate from Automation 360 to access Salesforce and run several command
actions by using the new Salesforce command пакет.
Salesforce пакет on page 1807

SAP GUI 770 version now supported (Service Cloud case ID: 01793132, 01792775, 1776805,
01792623, 787725, 01805482, 01805479,01792623, 01810356, 01822839, 01851451, 01853577,
01860050)
SAP GUI 770 (patch 6) is now certified and supported with Средство записи and SAP пакет.

Средство записи actions supported in various SAP versions on page 1786

Configure and use custom proxy configuration in Веб-служба REST пакет (Service Cloud
case ID: 01271527, 01765084, 01839282)
Веб-служба REST пакет is now enhanced to support custom proxy configuration for each Delete,
Get, Patch, Post, and Put action. This provides you more flexibility in calling REST APIs with
different proxy configuration and allow you to create hybrid API automation.

Веб-служба REST пакет on page 1793

Keyboard shortcuts to reduce scrolling
When developing large боты, you can now use keyboard shortcuts to expand and collapse
individual or all sections and move through the lines of code quickly instead of scrolling and
minimizing sections individually.
Keyboard shortcuts to expand or collapse elements in бот logic on page 1376

Set value in any editable control field to be blank in SAP application (Service Cloud case
ID: 00821861, 01807129)
When you use the Set text action of the SAP пакет, you can now set the value in any editable
control field in the SAP application to be blank. For example, you can set the value in the text field
or the date field to be blank.

Loop through emails and move them one at a time (Service Cloud case ID: 00749763,
01807189, 01840743)
You can now loop through all the emails in a mailbox and move one email at a time to a destination
folder by using the Move action in the Эл. почта пакет.
Move action on page 1520

Configure p12 certificate for SOAP-based automations (Service Cloud case ID: 00757213)
In the Веб-служба SOAP action, you can now select the p12 certificate file and provide a password
for user authentication. With this enhancement, you can now access web services that use the p12
certificate-based authentication (a more secure type of SSL certificate).

Пример использования действия веб-службы SOAP on page 2090
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What's new

Improved accessibility, usability of content on Эмулятор терминала window (Service
Cloud case ID: 01609467)
You can now have improved accessibility and usability of the content displayed on the Эмулятор
терминала window. When you use the enhanced Get text action of the Эмулятор терминала
пакет, you can now view and extract all the lines and text present in the Эмулятор терминала
window and perform an operation based on your requirement.
Using Get text action for Эмулятор терминала on page 1922

Run боты with or without window title matching in letter case
You can now run боты even when the title of a captured window does not match the letter case.
For a бот to identify a static window or browser titles and titles with a wildcard character, you can
opt for a case-sensitive match if you want the letter case to be matched, or a case-insensitive
match otherwise, by using the Case sensitive option.

Control image preview and storage in Control Room during secure recording
You can now choose whether or not the object images are available for preview and stored in the
Control Room during secure recording by enabling the Recorder preview image setting. When
you enable the setting, the image is previewed in the Bot editor and stored in the Control Room for
60 minutes. If you choose not to preview, images are not captured.

Безопасная запись on page 38 | Secure recording mode on page 1977 | Настройки on page 2737

Automate Microsoft Excel spreadsheets from SharePoint
You can now automate Microsoft Excel spreadsheets that are uploaded and shared on SharePoint.
Use Excel advanced > Open action to open the Microsoft Excel spreadsheets from SharePoint
location.
Using the Open action for Расширенный Excel on page 1552

Automate Citrix Virtual Apps in Edge with IE mode
When using the Средство записи, you can now automate Citrix Virtual Apps running on Microsoft
Edge Chromium with IE mode.

Automate controls using Microsoft UI Automation (COM) technology
For automation, you can now use the Microsoft UI Automation (COM) technology in the following
scenarios:
• Capturing controls with secure recording mode
• Capturing and automating combo box and list view controls
• Using Object exists and Object does not exist Средство записи conditions in Если, Цикл,

and Ожидать пакеты

Capture using specific technology on page 1785 | Actions performed on objects captured with Universal
Recorder on page 1770
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What's new

Seamless automation of Citrix Virtual Apps and other Citrix applications
With the new Automation 360 remote agent for Citrix, you can now seamlessly automate all types
of Citrix Virtual Apps and other Citrix applications that are supported on desktop applications using
the Средство записи.
The new Automation 360 remote agent for Citrix supports the following browsers and technologies:
• Google Chrome
• Internet Explorer
• Microsoft Edge
• Microsoft Edge в режиме IE
• Mozilla Firefox
• Java
• Electron apps
• Microsoft Active Accessibility (MSAA)
• Microsoft UI automation

Installing Automation Anywhere remote agent on Citrix servers on page 888 | Using the Recorder on
Citrix Virtual Apps servers on page 883

Implement coding standards with code analysis
You can now implement best coding practices by configuring coding rules in the Control Room.
This feature helps you prevent potential errors, improve бот reliability, and makes the code more
uniform, accessible, reliable, and efficient.
• As an administrator or a user with View policies and Manage policies permission, you can

configure the code analysis policy for all users.
• As a Непрофессиональный разработчик, you can run code analysis to analyze your боты

against readability, maintenance, security, and compliance best practices.

Анализ кода on page 2798

Fetch execution details for specific execution IDs with new Control Room API
You can now fetch the execution details, such as botOutVariables and CallbackInfo, for a
specific execution ID by using the new API endpoint, V3/activity/execution/<id> API.
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Automation Anywhere Robotic Interface (AARI)

What's new

Embedded automation with OAuth 2.0
Embedded automation streamlines access to the automation experience.
Embedded Automation on page 2235
• AARI Integrations embeds in web applications as a widget, so if you are an end user, you can

access automated processes and боты without leaving your environment.
• AARI Extensions offers further adaptability through Chrome browser extensions, enabling

automation directly in any web scenario. Business users can now access automations through a
widget, available through an extension in their web browser.

• With an OAuth 2.0 connection, existing access to automations in the Control Room are now
shared with the Extensions to offer you a seamless user experience.

AARI Integrations и AARI Extensions on page 2238

Delete files permanently from AARI cloud storage
You can now delete files permanently from AARI cloud storage. When you delete a request, the
associated file is also permanently deleted now and not just sent to the recycle bin.
Cloud storage usage on page 2144

Append or overwrite operations in your form
Append or overwrite operations in your form by using the Assign form rules for the web, with the
Checkbox and Radio Button elements, which now support form rules.

Assign dynamic values with support for new elements in your forms
When you use the interactive forms пакет, you can now assign dynamic values with the Assign
action, which now supports Checkbox and Radio Button elements in your form.
You can also change the label of the selected form elements with the Change label action for the
Button element.
Interactive forms пакет on page 1651

IQ Bot

What's new

Search for form or table fields
When creating a learning instance, when you are configuring fields, you can now search for fields
by field name, field label, or data type.

Заметки Community Edition о выпуске Automation 360 v.25
Дата выпуска: 21 июня 2022 года
Просмотрите в Community Edition новые возможности выпуска Automation 360 v.25 (Сборка 14304).
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Важное замечание:  Этот выпуск включает в себя необязательное обновление Bot Agent. You
can continue to run your existing боты without updating the Bot Agent. However, if you want to use the
new features in Automation 360 v.25, you must update the Bot Agent available with this release.

Более подробную информацию об обновлении до этого выпуска см. на указанных ниже ресурсах.
• Автоматическое обновление Bot Agent | Обновление Bot Agent вручную
• Compatibility with release builds

Рабочая область RPA

Новые возможности

Поддержка автоматизации приложений, поддерживаемых в приложении Citrix
Workspace (ID обращения к облачному сервису: 01758063)
The Citrix Workspace app is now supported on Automation 360. You can now automate applications
that are accessed through the Citrix Workspace app by using the Recorder > Capture action or
the Start recording option.

Установка Bot Agent на устройствах, на которых имеется Enterprise Client Enterprise
11
При создании бот в Automation 360 вы теперь можете установить Bot Agent на устройстве
с существующим Enterprise Client Enterprise 11. Вы можете создавать или запускать боты из
обоих экземпляров Control Room.

Установка Bot Agent и регистрация устройств

Баннер с уведомлением о прекращении поддержки IE 11 в Control Room
Начиная с выпуска Automation 360 v.25, при использовании браузера Microsoft Internet
Explorer для доступа к Control Room вам будет предложено использовать альтернативные
поддерживаемые браузеры, такие как Google Chrome или Microsoft Edge (Chromium). Когда вы
входите в Control Room, отображается баннер с уведомлением о том, что поддержка Internet
Explorer 11 прекращается.

Вход в Automation Anywhere Control Room

AISense Recorder.Поддержка корейского языка и сложных операций с таблицами
• Теперь можно использовать AISense Recorder для автоматизации приложений,

использующих корейский язык и сочетание корейского и английского интерфейсов.
AISense для записи задач из удаленных приложений

• С помощью AISense Recorder теперь можно извлекать табличные данные из сложных
таблиц. Вы можете записывать и автоматизировать таблицы с более широкими столбцами
и таблицы, в которых есть столбцы с элементами управления, такими как флажки или
параметры. Вы также можете извлекать определенные столбцы из таблиц.

Прим.:  Если таблица не распознается автоматически, воспользуйтесь параметром
Определить для обнаружения таблицы.

Table data extraction through AISense Recorder
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Новые возможности

Усовершенствования Средство записи
• При запуске бот теперь можно автоматизировать объекты, которые появляются за

окном выполнения бот, с помощью action Средство записи > Запись. (ID обращения к
облачному сервису: 00684306, 00770636, 01146672)

• Теперь вы можете использовать Средство записи для записи и автоматизации объектов с
определенной технологией. Теперь на вкладке Сделать снимок объекта есть параметр
для выбора конкретной технологии и записи с использованием этой технологии. Вы
можете записывать объекты с помощью следующих технологий:
• Microsoft Active Accessibility (MSAA)
• UI automation
• Microsoft (MS) COM UI Automation

Capture using specific technology

(ID обращения к облачному сервису: 01760871, 01865823
• You can now use the Средство записи to automate third-party plug-in window objects on

Google Chrome or Microsoft Edge browsers by using a specific technology.

Параметр Уменьшить потерю данных в пакет PDF
В action PDF > Извлечь текст для поля типа Структурированный текст теперь доступен
новый параметр Уменьшить потерю данных. При использовании этого параметра вы
можете извлечь полный текст с минимальным перекрытием символов.
Using Extract text action from PDF

Усовершенствования пакет Строка (ID обращения к облачному сервису: 00770822)
В action Строка > Извлечь текст теперь доступен новый параметр При извлечении. Вы
можете использовать этот параметр, чтобы указать, должен ли регистр текста в извлеченной
подстроке совпадать с регистром исходной строки.
Using Extract text action of Строка пакет

Загрузка файлов с URL-адресов, требующих аутентификации NTLM (ID обращения к
облачному сервису: 01189873)
С помощью улучшенного пакет Браузер теперь можно загружать файлы с URL-адресов,
требующих аутентификации NTLM, с помощью action Браузер > Загрузить файл.

Усовершенствование параметра нескольких вложений в action «Отправить
сообщение эл. почты» (ID обращения к облачному сервису: 00800976, 00817136,
00821405, 00936080, 01256523, 01256320, 01262069, 01259369, 00936080, 01801928)
При отправке сообщений электронной почты из боты теперь можно отправлять несколько
вложений в виде списка файлов или переменной, содержащей список объектов файлов. С
помощью этой функции вы можете прикреплять к сообщениям электронной почты такие
файлы, как файлы данных, электронные таблицы и документы текстовых редакторов.
Можно прикреплять несколько путей к файлам на локальном или сетевом диске, а также
использовать переменную, содержащую путь к файлам.
Using the Send action
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Новые возможности

Усовершенствование пакет Веб-служба SOAP
Когда вы создаете ответ SOAP для выражения Xpath в пакет Веб-служба SOAP, результат
выражения Xpath может быть сохранен в виде списка строк.

Пример использования действия веб-службы SOAP

Просмотр истории версий зависимостей файлов, не относящихся к бот (ID
обращения к облачному сервису: 01615105)
Теперь вы можете просматривать историю версий зависимостей файлов, не относящихся к
бот. Это помогает определить изменения, внесенные в ваш файл другими пользователями в
определенный день и определенное время, а также просмотреть сообщения о загрузке.
View version history of non-бот file dependencies

Редактирование непустых имен папок в личной рабочей области (ID обращения к
облачному сервису: 00535388, 00730075, 00786633, 00791528, 01615295, 01820406)
Теперь вы можете редактировать непустые имена папок в личной рабочей области.
Благодаря этой функции теперь легче управлять папками. При переименовании папки
проверьте, что выполняются следующие условия.
• Она не содержит выгруженных или клонированных боты даже на уровне вложенных

папок.
• Она содержит не более 100 элементов, включая вложенные папки и файлы.

Создание и переименование папок

Просмотр карт зависимостей для боты
Теперь вы можете просматривать карту зависимостей для вашего бот в общей и личной
рабочих областях. Карта зависимостей показывает непосредственные родительские
и дочерние боты для любого выбранного бот. Если вы разработчик RPA, вы можете
использовать карту зависимостей, чтобы лучше понимать, где вызывается бот и какие
дочерние боты вызываются бот. С помощью этой информации вы можете оценить влияние
изменения в бот, эффективно использовать бот, улучшить код бот и возможность его
повторного использования, а также предотвращать конфликты.
View бот dependency map

Automation Anywhere Robotic Interface (AARI)

Новые возможности

Создание запроса в новой вкладке
Теперь вы можете открывать и запускать новые запросы в отдельной вкладке, выбрав
параметр Открыть запрос в новой вкладке в исходной форме. С помощью этого
параметра вы можете одновременно создавать запросы, не уходя с открытой в данный
момент страницы.

Создание запроса и завершение задачи
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Новые возможности

Дублирование строк для элемента «Таблица»
В веб-интерфейсе, когда вы добавляете строки в форму с помощью элемента Таблица,
теперь можно сэкономить время, продублировав строку в таблице с помощью нового
параметра Дублировать строку. Дублированная строка теперь размещается под
выделенной строкой, которую вы выбрали.

Триггеры интерфейса поддерживают больше технологий
Теперь вы можете использовать триггеры интерфейса со следующими технологиями:
• собственная технология Windows,
• рабочий стол SAP,
• браузеры Google Chrome и Edge Chromium.

Add an interface trigger
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Новые возможности

Усовершенствования правил формы
• Использование пользовательского форматирования

При добавлении правила, если вы используете меню Если для задания условий правила
для определенных элементов, таких как Текстовое поле или Область текста, вы
теперь можете выбрать вариант Является из раскрывающегося меню для активации
дополнительных параметров. Select the Custom option and click Add regular expression
to apply custom formatting requirements on the selected element.
Рассмотрим сценарий, в котором идентификаторы пользователей всех ваших сотрудников
имеют префикс AV. Так, например, сотрудник, которого зовут Адам, имеет идентификатор
пользователя AVAdam. Используйте параметр Добавить регулярное выражение, чтобы
установить в поле Регулярное выражение значение «^AV». Если пользователь вводит
Adam в поле идентификатора пользователя, отображается предупреждение.

• Установка пользовательского значения или добавление значения элемента
Когда вы добавляете правило, используйте меню Тогда для выбора элемента формы.
Для этого элемента формы можно задать одно из соответствующих действий с помощью
функции Установить значение или Добавить значение:
• Значение: данные, введенные в поле Введите значение, применяются к выбранному

элементу.
• Элемент формы: добавляются данные из элемента формы, выбранного в

раскрывающемся меню Выбрать элемент.

Рассмотрим сценарий, в котором форма регистрации пользователя содержит поля «Имя»
и «Идентификатор сотрудника». Вы можете установить одно из следующих правил для
значения в поле «Идентификатор сотрудника»:
• Выберите Значение и введите Emp1013 в качестве предустановленного значения.

Это значение отображается в поле «Идентификатор сотрудника» при запуске бот.
• Выберите Элемент формы и элемент «Имя» в раскрывающемся меню Выбрать

элемент.
Значение из поля «Имя» добавляется к полю «Идентификатор сотрудника» при запуске
бот.

Вы можете использовать элементы так же, как используются переменные в Bot editor. Вы
можете ввести $ для просмотра списка элементов.

Добавление правил к элементам формы

Document Automation

IQ Bot Extraction360 (предварительная версия) теперь Document Automation. Community Edition
позволяет пользователям опробовать функции из Document Automation, включая создание до пяти
обучаемых экземпляров, подключение к обучаемым экземплярам в Automation 360 IQ Bot, загрузку
документов для обработки и проверку документов с помощью диспетчера задач AARI.
Community Edition
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Изменения

В папке Рабочая область документов теперь содержатся активы обучаемых экземпляров
(боты, процесс и форма). Ранее эти активы находились в папке Процессы IQ Bot.

actions, которые поддерживают обработку документов, теперь находятся в пакет Document
Extraction. Ранее эти actions находились в пакет IQ Bot Extraction360 (предварительная
версия) .

Обучаемые экземпляры из предыдущих выпусков удалены, чтобы обеспечить обновление до
Сборка 14304.

Ограничения

Document Automation поддерживает имя пользователя устройства длиной 21 символ или
менее.

The value beside the Validate documents link, which indicates the number of documents
awaiting validation for a learning instance, sometimes does not appear.

When you are validating a document, if you draw a box, zoom in, and then click Fit to screen, the
box appears at a different location from where you clicked.

Если вы подключаетесь к обучаемому экземпляру из Automation 360 IQ Bot с дополнительным
полем, для которого установлено значение по умолчанию, и несколькими полями без
сопоставления, то при обработке документов в этом обучаемом экземпляре в Document
Automation значение по умолчанию появляется в несопоставленных полях.

When a бот runs an action from the Document Extraction пакет, the Activity > In progress page
shows the item name as IQBotAutoExtract.

Хотя на странице «Обучаемые экземпляры» указано, что пользователи не могут удалять
обучаемые экземпляры, пользователь может удалить обучаемый экземпляр, наведя курсор на
меню действий справа от обучаемого экземпляра и щелкнув по значку Удалить.

Заметки Community Edition о выпуске Automation 360 v.24
Дата выпуска: 22 марта 2022 г.

Просмотрите в Community Edition новые возможности выпуска Automation 360 v.24 (Сборка 12350).

Прим.:  Подробную информацию об исправлении Automation 360 v.24R2 для Community Edition см. в
разделе «Заметки о выпуске Automation 360 v.24R2 для прекращения поддержки Internet Explorer 11».

Рабочая область RPA

Важное замечание:  Этот выпуск включает в себя необязательное обновление Bot Agent. Для
использования новых функций в версии v.24 (включая обновления для миграции Бот, Браузер, DLL,
функции обнаружения процессов и пакеты Средство записи), обновите Bot Agent, доступный для
этого выпуска. Обратите внимание, что если вы хотите запустить существующие боты, обновление
Bot Agent до этого выпуска не требуется.

Более подробную информацию об обновлении до этого выпуска см. на указанных ниже ресурсах.
• Автоматическое обновление Bot Agent | Обновление Bot Agent вручную
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• Compatibility with release builds

Новые возможности

Больше возможностей с Microsoft Edge Chromium
Теперь можно использовать расширение браузера Microsoft Edge Chromium для указанных
ниже операций.
• Конфигурация прокси Bot Agent
• Автоматическое заполнение учетных данных устройства

Требования к браузеру для доступа к Рабочая область RPA

Сокращение времени решения проблем
Теперь можно сократить время сбора информации о проблемах путем записи файлов
журнала с устройства Bot Runner. Файлы журнала можно сохранить, используя новую
команду -collectlogs с утилитой диагностики Bot Agent.

Выполнение диагностических проверок Bot Agent

Усовершенствование AISense Recorder
Теперь можно использовать AISense Recorder для автоматизации приложений, использующих
японский язык и сочетание японского и английского интерфейсов.
AISense для записи задач из удаленных приложений

Поддержка копирования метаданных из одного бот в другой
Теперь можно копировать файлы изображений и метаданных из одного бот в другой с
помощью параметра Копировать в общий буфер обмена.

Параметр времени ожидания в Веб-служба SOAP и пакеты Веб-служба REST (ID
обращения к облачному сервису: 00756730, 00792793, 01255869, 01753287)
Теперь при создании бот можно установить значение времени ожидания для actions в
запросах REST и SOAP. Чтобы указать, как долго бот должен ждать ответа от сервера до
истечения времени ожидания, можно установить время ожидания (в миллисекундах) в поле
Время ожидания завершения действия. Можно ввести число или переменную или
указать глобальное значение.

Форматирование текста с помощью нового HTML-редактора в пакет Эл. почта
В пакет Эл. почта, когда используются действия Отправить, Ответить и Переслать actions,
теперь можно создавать и настраивать макет и тело письма с помощью нового редактора
дизайна HTML. Используйте панель инструментов редактора для внесения различных
изменений в текст, например применения полужирного шрифта, курсива и других эффектов
форматирования, вставки ссылок, изменения шрифта и размера текста. Содержимое можно
скопировать из редактора дизайна и вставлять его в другие окна.

Теперь TaskBotпакет поддерживает передачу переменной «Окно» в дочерний бот
(ID обращения к облачному сервису: 00691890, 00804359, 01258948, 01764292)
В action Запустить для пакет TaskBot, когда вы выбираете поля Входные значения и
вводите значения или переменные для передачи в дочерний бот, теперь можно выбрать
переменную типа Window и передать ее из родительского бот в дочерний бот.
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Новые возможности

Новая опция в поле «Тип содержимого» пакет Веб-служба REST (ID обращения к
облачному сервису: 00666852, 00789910, 00771194, 00785116, 00825945, 01762199)
Теперь можно использовать multipart/form-data для загрузки файлов и данных с
использованием Веб-служба REST. Для отправки элементов формы, содержащих файлы,
данные, отличные от ASCII, и двоичные данные, можно использовать тип содержимого
multipart/form-data. Эта опция доступна для таких actions, как POST, PUT и PATCH.

Опция пользовательского разделителя в пакет Веб-служба SOAP
Для ответов, специфичных для XPath, теперь можно использовать опцию пользовательского
разделителя для разделения содержимого, возвращаемого из ответа SOAP. В поле
Пользовательский разделитель можно ввести символ или переменную, и вывод
разделенного ответа будет полной строкой.

Новый параметр в action «Выполнить функцию» для пакет DLL (ID обращения к
облачному сервису: 00830568, 01063654, 01259336, 01767965)
В ходе выполнения action Выполнить функцию для пакет DLL, когда DLL C#
взаимодействует с API-интерфейсом Windows для выполнения системных операций, таких как
нажатие клавиш, щелчок кнопкой мыши или переключение окон, периодически отображается
промежуточное окно (AAZeroSizeForm), которое прерывает работу пользователя во время
выполнения бот. В некоторых случаях функция DLL не взаимодействует с API-интерфейсом
Windows для выполнения таких actions, как нажатие клавиш, щелчок кнопкой мыши,
переключение окон, в пользовательском интерфейсе операционной системы при
использовании функции DLL. В таких случаях можно установить флажок Выполнять
функцию в фоновом режиме, чтобы избежать появления промежуточного окна
(AAZeroSizeForm) и запустить DLL C# в консольном приложении без формы. Эта функция
также помогает повысить производительность выполнения DLL, если установлен флажок
Выполнять функцию в фоновом режиме.

В Bot editor поддерживается автопрокрутка (ID обращения к облачному сервису:
00730747)
При создании или редактировании боты с большим количеством строк кода и при
перетаскивании actions вверх или вниз по странице, теперь страница автоматически
прокручивается соответственно вверх или вниз. Эта функция поддерживается в обоих
представлениях: Поток и Список.

Новый пакет JSON
Используйте пакет JSON для автоматизации работы с данными JSON. Теперь можно извлекать
необходимую информацию из текста или файла JSON и напрямую использовать значения в
бот.

пакет JSON
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Новые возможности

Новая опция в action «Выявить» пакет Обработчик ошибок (ID обращения к
облачному сервису: 00766117)
Теперь в пакет Обработчик ошибок можно игнорировать ошибки в ходе выполнения actions
внутри блока Выявить. Для этого следует использовать флажок Выявить > При ошибке
выполнить следующее действие. При установке флажка При ошибке выполнить
следующее действие, даже если в ходе выполнения action в блоке Выявить произошла
ошибка, исключение не будет выдаваться и бот проигнорирует ошибку и перейдет к
следующему действию.

Прим.:  Это усовершенствование применяется ко всем вложенным actions в блоке Выявить .
Например, если у вас есть action Попробовать/Выявить внутри основного action Выявить
и установлен флажок в основном action Выявить, любая ошибка в ходе выполнения actions
из вложенного блока также будет игнорироваться.

Усовершенствование пакет «Строка»
В action Извлечь текст в пакет «Строка», когда вы используете параметр После или
До и (или) после, вы можете извлечь подстроку из указанной исходной строки, которая
встречается в файле от 1 до 999 999 раз.

Поиск файлов по определенной дате
Теперь можно искать файлы, созданные или измененные в определенную дату, с помощью
нового параметра По дате, доступному в условии Дата файла различных пакеты.
Вы можете использовать эту функцию с указанными ниже пакеты и actions.
• Файл пакет

• action Копировать файлы рабочего стола
• Удалить action
• Печать action
• Печать нескольких файлов action
• Переименовать action

• Папка пакет
• Копировать action
• Удалить action
• Переименовать action

• Если > Условие даты файла
• Цикл > While > Условие даты файла

Новое action в Расширенный Excel пакет (ID обращения к облачному сервису: 01263892,
01782290)
Теперь при выполнении actions на листе Microsoft Excel можно выключить или включить
обновление экрана в реальном времени с помощью нового action Выключить или
включить обновление экрана в реальном времени в пакет Расширенный Excel. Это
action полезно для повышения производительности автоматизаций на базе Excel во время
выполнения при работе с большими наборами данных.
Worksheet operations in Расширенный Excel
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Новые возможности

Используйте условия Средство записи в Microsoft Edge на базе Chromium в режиме
Internet Explorer (IE)
Теперь можно использовать условия Средство записи Объект существует и Объект не
существует в браузере Microsoft Edge на базе Chromium в режиме IE для указанных ниже
пакеты.
• Цикл > Условие While
• Ожидать > Ожидать условие
• Если пакет

Поддержка браузера Internet Explorer для пакет Браузер и переменных окна
• Следующие actions в Браузер пакет теперь поддерживаются в браузере Internet Explorer:

• Открыть
• Закрыть
• Назад
• Получить исходный код

• Теперь в параметре Браузер можно из списка активных вкладок выбрать вкладки Internet
Explorer.

Браузер пакет

Усовершенствование пакет Дата/время
Параметр Переменная в action Дата/время > Присвоить теперь расширен и разделен на
два параметра:
• Дата/время Позволяет выбрать дату и время вместе с часовым поясом вручную и

присвоить их переменной «Дата/время».
• Переменная. Позволяет выбрать переменную Дата/время или другие переменные,

которые могут иметь Дата/время в качестве подтипа, например, переменные «Словарь»,
«Запись» и «Список».

Использование действия «Присвоить»

Усовершенствование пакет Средство записи
Теперь вы можете делать снимки объектов и автоматизировать объекты внутри
междоменного IFrame, который содержит несколько элементов IFrame с одним и тем же
источником кадров, а также элементы IFrame, которые загружаются во время выполнения
в браузерах Google Chrome и Microsoft Edge Chromium. Это можно сделать это с помощью
параметра Средство записи > Запись или Начать запись. Эта поддержка также доступна
для автономных расширений Google Chrome.

Пакет Средство записи
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Новые возможности

Поддержка всплывающих окон и диалоговых окон в браузерах Google Chrome,
Microsoft Edge Chromium и Mozilla Firefox (ID обращения к облачному сервису: 00762207,
00769773, 00781196, 00786646, 00777907, 00795677, 00785995,00808600, 00811044, 00767486,
01282172, 01286665, 01256750, 01762040)
Теперь при автоматизации веб-страницы в поддерживаемых браузерах можно захватывать
всплывающие окна, диалоговые окна предупреждений, диалоговые окна подтверждения
и диалоговые окна с запросами, которые появляются. Это можно сделать это с помощью
параметра Средство записи > Запись или Начать запись.

Пакет Средство записи

Получение исходного кода iFrame в браузере Google Chrome
Теперь можно получить исходный код iFrame в браузере Google Chrome, используя action
Браузер > Получить исходный код. Для создания снимков этих элементов iFrame можно
использовать новый параметр  Сделать снимок объекта.

Прим.:  Функция Сделать снимок объекта является необязательной и используется только
для получения исходного кода iFrame.

Запуск JavaScript внутри iFrame в браузере Google Chrome
Теперь можно запустить JavaScript на странице, содержащей элементы iFrame, в браузере
Google Chrome, используя action Браузер > Выполнить JavaScript. Можно использовать
новый параметр Сделать снимок объекта для создания снимков элементов iFrame, для
которых вы хотите запустить JavaScript.

Прим.:  Функция  Сделать снимок объекта является необязательной и используется
только для выполнения JavaScript внутри iFrame.

Поддержка глобальных сеансов для пакет Базовый Excel
• Теперь для пакет Базовый Excel поддерживается параметр глобального сеанса.

Применяйте параметр «Глобальный сеанс» для совместного использования сеанса
Microsoft Excel для нескольких боты, что позволяет использовать один и тот же лист Excel
для всех этих боты.

• Теперь поле Имя сеанса переименовано в Создать сеанс Excel.

Using the Open action for Базовый Excel

Переменная по умолчанию для хранения данных числового типа
Теперь при создании или тестировании бот можно использовать числовую переменную по
умолчанию SampleNumber, включенную в палитру «Переменные».

Прим.:  Числовая переменная по умолчанию доступна только в новых боты.
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Новые возможности

Экспорт и импорт файлов, защищенных паролем
Теперь функции экспорта и импорта дополнены опцией пароля, что позволит повысить
безопасность, обеспечивая защиту от несанкционированного доступа и вредоносного
редактирования, а также защитить конфиденциальность. С помощью этой функции можно
выполнять указанные ниже действия.
• Установите пароль для файлов, которые собираетесь экспортировать из вашей Control

Room.
• Импортируйте защищенный паролем экспортированный файл в свою Control Room.

Экспортировать боты | Импорт боты

Новые возможности в конфигурации Git (ID обращения к облачному сервису: 00782957,
00837059, 00687394, 00783715, 00714059, 00659476, 00749755, 00786233, 00748166,
00776417)
Теперь для конфигурации Git можно выполнять указанные ниже действия.
• Выбрать метод проверки подлинности HTTPS или SSH для настройки конфигурации

Git. Метод проверки подлинности SSH является более безопасным, поскольку проверка
подлинности основана на паре открытого и закрытого ключа.

• Указать ветвь, в которую собираетесь перенести свои фиксации Git. Это помогает
координировать работу группы и управлять потоком операций.

• Подключитесь к своему репозиторию Git с помощью прокси-сервера.

Configure a remote Git repository in Control Room | Restore боты from Git repository

Automation Anywhere Robotic Interface (AARI)

Новые возможности

Поддержка Microsoft Edge Chromium и Safari для AARI
Теперь можно создавать формы и процессы в Рабочая область RPA и запускать запросы,
задачи и боты в веб-интерфейсе в браузерах Microsoft Edge Chromium и Safari.

Требования к браузеру для доступа к Рабочая область RPA

Создание полей паролей и скрытие конфиденциальной информации (ID обращения
к облачному сервису: 00714159, 01063512)
Теперь в Рабочая область RPA можно создавать поля паролей с помощью элемента Пароль в
конструкторе форм. Можно использовать элемент Пароль в веб-интерфейсе для добавления
маскированного текста в поля пароля в исходных формах, чтобы скрыть конфиденциальную
информацию.

Настройка процессов | Свойства элемента «Пароль»
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Новые возможности

Усовершенствование идентификатора ссылки для запросов
Теперь можно просмотреть идентификатор ссылки, связанный с вашим процессом, в столбце
Ссылка на странице Запросы. Идентификатор ссылки представляет собой комбинацию
префикса и номера, создаваемую на основе Ключа процесса, который можно ввести при
первом редактировании процесса. Этот идентификатор ссылки увеличивается каждый раз,
когда создается запрос от соответствующего процесса.

Свойства идентификатора ссылки | Configure an AARI process

Статус «Отменено» для задач
Теперь можно фильтровать задачи по статусу Отменено на странице Задачи. Этот статус
будет отображаться в виде метки Отменено рядом с отфильтрованными результатами,
чтобы информировать вас о том, какие задачи были отменены пользователем. Выполнять
фильтрацию по этому статусу можно из выпадающего меню на панели состояния.

Фильтрация и поиск задач

Заполнение элементов исходных форм по параметрам URL-адресов
Теперь при создании запроса теперь можно заполнять элементы исходных форм, создавая
сценарии запросов, которые вводят определенные параметры в URL-адрес начальной формы.
Эти параметры применимы только для элементов Дата, Число, Текстовое поле и Время.

Параметры URL-адреса

Настройка текста в формах с использованием обновлений элемента «Метка»
Теперь можно настраивать текст в формах различными способами, например, применять
полужирный шрифт, курсив, нижнее подчеркивание и другие эффекты форматирования,
изменять размер и цвет шрифта и так далее, используя элемент Метка. С помощью
этих параметров можно выделить определенные сообщения или тексты, такие как
следующие шаги, предупреждения или ошибки, когда они отображаются в исходной форме в
веб-интерфейсе.
Теперь элемент Метка предоставляет указанные ниже параметры форматирования.
• Выделение
• Цвет шрифта
• Размер шрифта
• Выравнивание текста

Использование элемента «Метка»

Поиск и фильтрация столбцов в таблице
Если на экране конструктора форм установить флажок Включить фильтрацию столбцов
для элемента Таблица, пользователи смогут выполнять поиск и фильтрацию содержимого
по всем доступным столбцам во время выполнения бот.
Теперь при использовании элемента Таблица для отображения таблицы в исходных формах
у вас есть расширенная возможность поиска каждого столбца таблицы по значению.

Использование элемента «Таблица»
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Discovery Bot

Новые возможности

Сохранение записи с именем
После записи процесса можно сохранить запись с именем. Имя записи отображается на
странице Записи для этого процесса.

Запись бизнес-процесса Discovery Bot

Предоставление общего доступа к описанию записи
Теперь можно предоставить описание для записи процесса, используя страницу Записи для
этого процесса. На странице Записи воспользуйтесь полем Описание, чтобы предоставить
аналитику доступ к контексту и цели записи. Представленное описание отображается также в
PDD.

Запись бизнес-процесса Discovery Bot

Удаление записи
После записи процесса, если вы не хотите отправлять данные записи аналитику для
просмотра, вы можете удалить эту запись, используя страницу Записи для этого процесса.
Чтобы удалить запись, воспользуйтесь параметром Удалить на странице Записи.

Запись бизнес-процесса Discovery Bot

Запись бизнес-процессов с использованием AARI Assistant
Теперь для записи бизнес-процессов без входа в Control Room можно использовать AARI
Assistant. Чтобы записать бизнес-процесс, запустите AARI Assistant двойным щелчком по AARI
на рабочем столе.

Запись процесса Discovery Bot с использованием AARI Assistant

Расширение пользовательских возможностей
Теперь можно обновить потенциальные затраты и экономию для пользовательских
возможностей и сохранить изменения на диаграмме процесса. Потенциальные затраты
и потенциальная экономия могут быть обновлены в любое время по мере того, как вы
просматриваете шаги из различных записей и вносите изменения в диаграмму процесса.

Анализ возможностей, преобразование в бот и создание PDD

Улучшение PDD
Теперь можно просмотреть всю диаграмму процесса изнутри Discovery Bot, щелкнув по
ссылке на URL-адрес, предоставленной в PDD. Если выбрано более 100 шагов, диаграмма
процесса в PDD не отображается.

Анализ возможностей, преобразование в бот и создание PDD

Исправления

ID обращения к
облачному сервису

Описание

-- Теперь в Community Edition и бесплатной пробной версии можно
создать и удалить пять и более процессов, а возможность
автоматической генерации не дает сбоев. Вы можете создать до
пяти возможностей.
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Заметки Community Edition о выпуске Automation 360 v.23
Дата выпуска: 30 декабря 2021 года
Review what's new in the Community Edition of the Automation 360 v.23 (Build 11524) release. Build
11524 replaces Build 11513.

Важное замечание:  Build 11524 includes a fix for the issue of frequent device disconnections caused
by either high load or the database being locked.

Рабочая область RPA

Важное замечание:  This release includes a required update to your . Ensure that you complete the
update to continue with your automation activities when upgrading from a previous release to this release.

Автоматическое обновление Bot Agent | Обновление Bot Agent вручную

To verify which  version is compatible with this release, see Compatibility with release builds.

Новые возможности

Microsoft Edge (Chromium) поддерживается для Control Room и Bot Agent
Теперь вы можете выполнять операции с Control Room, а также устанавливать и
регистрировать ваше устройство Bot Agent с помощью Microsoft Edge на основе Chromium.

Требования к браузеру для доступа к Рабочая область RPA

Поддержка автоматизации Microsoft Edge Chromium с режимом совместимости
Internet Explorer (ID обращения к облачному сервису: 00767502, 00787186)
Теперь вы можете автоматизировать веб-приложения, работающие на Microsoft Edge
Chromium, включив режим совместимости Internet Explorer, используя Universal Recorder, где
запись объектов ведется с помощью технологии HTML.
Record a task with the Universal Recorder

Поддержка междоменных iFrame в браузерах Google Chrome и Microsoft Edge
Chromium (ID обращения к облачному сервису: 00825656)
Теперь можно записывать и автоматизировать объекты внутри междоменного iFrame в
браузерах Google Chrome и Microsoft Edge Chromium, используя меню Средства записи >
Запись или параметр Начать запись. После записи объекта внутри междоменного IFrame
путь к кадру по умолчанию сохраняется в свойстве FrameDOMXPath.
Новый FrameDOMXPath определяет путь к кадру, в котором находится объект. Это свойство
необходимо выбрать, чтобы запустить бот для успешной записи объектов на междоменном
IFrame.

Прим.:  Эта функция доступна для боты, создаваемых с помощью версии
2.4.0-20211016-070100 пакет Средство записи, начиная с этого выпуска.

Пакет Средство записи
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Новые возможности

Поддержка действия «Сделать снимок привязки» в AISense Recorder
AISense Recorder теперь поддерживает параметр Сделать снимок привязки. При
запуске бот для поиска объекта в приложении, в котором привязка часто меняется, можно
использовать Сделать снимок привязки, чтобы переопределить привязку по умолчанию и
вручную выбрать привязку для обнаружения объекта.
Edit a task recorded using AISense

Улучшенная поддержка при выборе свойства объекта в пакет Средство записи
После записи снимка объекта с помощью Средство записи > Запись action вы можете
выбрать имя свойства объекта из списка доступных свойств, чтобы получить значение
свойства объекта с помощью action Получить свойство. Список включает предложенные
имена свойств из критериев поиска в таблице Свойства объекта.

Пакет Средство записи

Идентификатор файла, поддерживаемый при проверке разрешения action из
пакет Google Диск (ID обращения к облачному сервису: 00777716)
action Проверить разрешения из пакет Google Диск теперь поддерживает параметр
Идентификатор файла для ссылки на файлы, доступные в папке Shared with me на
Google Диске. Указав ID файла, вы можете проверить доступ для Чтения, Записи или
Удаления файлов в папке Shared with me на Google Диске.

Пакет Google Диск

Новый пакет компонентов учетных данных
Теперь можно использовать action Присвоить в пакет «Учетные данные» для присвоения
небезопасной строки или переменной непосредственно переменной учетных данных.

пакет «Учетные данные»

Безопасность веб-служб поддерживается в пакет Веб-служба SOAP  (ID обращения к
облачному сервису: 00481836)
Теперь в качестве Bot Creator можно предоставлять переменные учетных данных в
необработанных данных action Веб-службы SOAP. Вы можете создать переменную учетных
данных, сопоставить учетные данные с именем ссылки в модуле сопоставления учетных
данных и использовать имя ссылки в необработанных данных. Поскольку это гарантирует, что
все данные, связанные с безопасностью, могут быть определены в Credential Vault, а учетные
данные могут быть использованы в боты, можно безопасно развертывать задачи без ущерба
для безопасности.

Пример использования действия веб-службы SOAP

Новый параметр в пакет Веб-служба SOAP
Для извлечения значений из ответа SOAP используйте параметр Создать Xpath в пакет
Веб-служба SOAP. Теперь вы можете указать выражение Xpath или выбрать соответствующий
узел из тела ответа и сохранить полученные данные в переменной.

Чтение электронной почты из общего почтового ящика в Microsoft Outlook (ID
обращения к облачному сервису: 00728579, 00831622)
Для автоматизации задач, связанных с электронной почтой, теперь вы можете выбрать
общую учетную запись в Microsoft Outlook, чтобы сообщения электронной почты можно было
читать из общего почтового ящика.
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Новые возможности

Новые типы кодировок, поддерживаемые в action «Записать в файл» из пакет
Таблица данных (ID обращения к облачному сервису: 00767158)
При использовании action Записать в файл для записи данных из переменной типа Таблица
в файл CSV или TXT теперь можно использовать указанные ниже типы кодировок из списка.
• UTF-8: Работает как UTF-8 без BOM
• UTF-8 с BOM (ранее назывался UTF-8)
• UTF-16LE
• Shift-JIS (японская кодировка)

Функции автоматического сохранения в Bot editor
В Bot editor при использовании actions для создания автоматизации, когда бот не сохраняется
вручную, выполняется автоматическое сохранение и бот теперь автоматически сохраняет
изменения для определенных событий.

Прим.:  В настоящее время функция автоматического сохранения доступна только для
определенных событий.

Ниже перечислены некоторые события, поддерживающие функцию автоматического
сохранения.
• Средство записи При создании бот с определенными actions и щелчке по кнопке

Средство записи событие сохраняется, а когда запись завершена, событие сохраняется
автоматически.

• Менеджер переменных. Когда вы создаете или редактируете переменные, чтобы вставить
их в поле action, изменения сохраняются.

Прим.:  Функция автоматического сохранения не поддерживается, когда вы удаляете
переменную или вставляете ее, нажав клавишу F2 для открытия списка переменных.

• Меню действий (вертикальное многоточие): При выборе из этого меню любого action,
например (Пакеты событие сохраняется автоматически. При внесении каких-либо
изменений на странице Пакеты и возврате на страницу Bot editor, событие сохраняется.

• Найти файл. При щелчке по значку Найти файл бот сохраняется, если он не был
сохранен вручную. Кроме того, после щелчка по кнопке Добавить бот сохраняется
автоматически.

• Диалоговые окна. При открытии диалогового окна оно автоматически сохраняется, если в
него были внесены какие-либо изменения.

Прим.:  Автоматическое сохранение срабатывает только для диалоговых окон верхнего
уровня, но не для вложенных диалоговых окон.

• Удаление переменных. При удалении неиспользуемых переменных событие сохраняется.
• Изменение названия Бот. При изменении названия бот событие будет сохранено.

Новая возможность в пакет FTP / SFTP (ID обращения к облачному сервису: 00792346)
Используйте вариант Компонент учетных данных при подключении к серверу типа
Secure FTP для автоматического выполнения задачи. Теперь для аутентификации можно
использовать имя пользователя и пароль.
Connect action
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Новые возможности

Усовершенствование AISense Recorder
AISense Recorder теперь поддерживает автоматизацию приложений, использующих
интерфейс на бразильском варианте португальского и сочетание бразильского варианта
португальского и английского языков.
AISense для записи задач из удаленных приложений

Усовершенствование пакет «Число»
• В action Случайная пакет «Число» можно указать и ограничить количество десятичных

разрядов, требуемых в случайном числе, генерируемом на выходе.
• Существующее поле Сохранить результат в числовой переменной теперь

переименовано в Сохранить результат в переменной.

Число пакет

Усовершенствование пакет «Ожидание»
Используйте новую функцию Сделать снимок области в action Ожидать изменения
экрана в пакет «Ожидание» для записи снимка определенной области в приложении,
нарисовав вокруг нее прямоугольник таким образом, чтобы бот автоматически записывал
снимок координат этой области. Вы можете выполнить указанные ниже действия.
• Сделать снимок определенной области в приложении «Окна».
• Выполнить предварительный просмотр изображения на снимке в окне

Предварительный просмотр.
• Восстановить область, если изображение в окне Предварительный просмотр не

соответствует требованиям пользователя.

Координаты переименовываются указанным ниже образом.
• Влево теперь X
• По верхнему краю теперь Y
• Вправо теперь Ширина
• По нижнему краю теперь Высота

Using Wait for screen change action

Усовершенствование пакет «Строка»
В action Извлечь текст пакет «Строка» теперь вы можете извлечь подстроку из указанной
исходной строки, которая встречается в файле более 1000 раз и до максимального предела
999999.

Усовершенствование условий обработки файлов в пакет «Если»
Теперь можно использовать новое условие Расширение файла из списка Условие в пакет
Если для проверки расширений файлов и последующего выполнения actions на основе
полученных результатов.

Усовершенствование в пакет Расширенный Excel (ID обращения к облачному сервису:
00799071)
Используйте action Открыть из пакет Расширенный Excel, чтобы открывать файлы с
расширением .ods, .htm, .html, .mht, .mhtml, .slk и .pdf.

Расширенный Excel пакет
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Поддержка глобальных сеансов для итератора цикла на основе Расширенный
Excel
Теперь вы можете использовать параметр Глобальный сеанс при циклическом просмотре
каждой строки в листе Расширенный Excel. Используйте параметр Глобальный сеанс
для совместного использования сеанса Microsoft Excel в нескольких боты, что позволяет
использовать один и тот же лист Excel во всех этих боты.
Using the Open action for Расширенный Excel

Новые API-интерфейсы для устройств
Теперь можно распределять устройства по умолчанию, используя новые API-интерфейсы,
введенные в разделе v1/Devices. Выберите: задать или не задавать определенное
устройство в качестве устройства развертывания по умолчанию для указанного пользователя,
используя следующие API-интерфейсы соответственно:
• /runasusers/default
• /runasusers/default/unset

Automation Anywhere Robotic Interface (AARI)

Новые возможности

Новый фильтр запросов в действиях «Запросы» и «Задачи запросов»
Используйте новый фильтр, который теперь доступен в actions Запросы и Задачи
запросов пакет AARI Web для фильтрации запросов и заданий по названию команды в
веб-интерфейсе AARI.

Фильтр названий групп
Вы можете фильтровать свои задачи и запросы по названию команды на страницах
веб-интерфейса Задача и Запрос соответственно. Выберите метку Группа в фильтре и
выполните поиск по имени группы, чтобы просмотреть команды, назначенные задаче или
запросу.
Filter and search for a request | Фильтрация и поиск задач

Поддержка журналов аудита (ID обращения к облачному сервису: 00801166)
Теперь вы можете просматривать журналы аудита и ссылаться на события, связанные
с запросами, группами, планировщиками, настройками процессов, настройками ботов,
задачами, выполняемыми человеком и задачами, выполняемыми ботом, которые вы создали,
удалили, обновили, отправили или восстановили.

Журнал аудита
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Усовершенствование назначения задач пользователя в задаче, выполняемой
человеком
В редакторе процессов параметр Автоматически назначить эту задачу в Задаче,
выполняемой человеком предоставляет указанные ниже альтернативы.
• Пользователь, создавший запрос. Задача автоматически назначается пользователю,

создающему запрос в веб-интерфейсе.
• Пользователь, открывающий эту задачу. Задача автоматически назначается

пользователю, который открывает задачу в веб-интерфейсе.

Эта функция помогает уменьшить конфликты при назначении задач самому себе, особенно
в случае специализированных пользователей, таких как Валидатор, для которых действие
открытия задачи эквивалентно назначению задачи самому себе.

Усовершенствование настройки группы
Теперь в группу в веб-интерфейсе AARI можно одновременно добавить несколько
пользователей с одинаковыми ролями (пользовательская роль). Пользовательская роль в
Control Room теперь согласуется с группой в веб-интерфейсе AARI, и расширенная настройка
группы работает указанным ниже образом.
• Пользователям, добавленным с этой ролью, присваивается роль Участник в группе. Роль

не может быть изменена на Владелец или Администратор.
• Вы не можете просматривать этих пользователей на вкладке Пользователи страницы

Группа.
• Если пользователь одновременно является частью роли и добавлен в группу вручную,

его роль в группе будет такой же, как и роль, назначенная ему вручную. Например, если
пользователь является членом клуба, он будет иметь роль Участник, тогда как если
пользователь является владельцем, в группе ему будет присвоена роль Владелец.

• Если пользователь больше не является частью роли, он также не будет являться частью
группы.

Также страница Группа теперь дополнена параметрами навигации в верхней части, чтобы
вы могли перемещаться по различным вкладкам (Общие, Пользователи, Роли, Процессы
и Боты). Используйте вкладки Общие, Пользователи и Роли для создания групп и
добавления в них пользователей. На вкладках Процессы и Боты отображаются процессы и
боты, назначенные группам, соответственно.
Team management | Create an AARI team and assign team roles to members

Поддержка при настройке бота
Администратор AARI может использовать страницу Настройка бота, чтобы просматривать
боты, которые назначены группе, назначать группы бот и редактировать боты для удаления
или переназначения групп. Bot Runner с сопровождением, имеющие право просмотра всех
боты, которые загружены в рабочей области Общие, теперь могут просматривать боты,
которые назначены группам в AARI Assistant.

Бот setup

Усовершенствование логотипа формы
Теперь поле Логотипы в нижнем колонтитуле можно использовать для выбора до двух
отдельных логотипов, которые будут отображаться в нижнем колонтитуле формы во время
работы бот.
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Новые возможности

Добавление правил к различным элементам формы
При создании или редактировании формы в конструкторе форм теперь правила к указанным
ниже элементам формы можно добавлять с помощью вкладки Правила формы.
• Флажок
• Дата
• Документ
• Выпадающее меню
• Метка
• Номер
• Пароль
• Переключатель
• Редактор Rich Text
• Область текста
• Текстовое поле
• Время

Для элементовФлажок и Переключатель правила срабатывают, только если выбраны
соответствующие предустановки. Например, если форма имеет два взаимоисключающих
параметра, таких как Да и Нет, то правила, связанные с этими параметрами, срабатывают
только при выборе одного из двух параметров.

Добавление правил к элементам формы
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Обновления триггеров
Теперь для запуска a бот доступны указанные ниже триггеры.
• Триггер процесса. Запускает бот, когда статус указанного процесса в Microsoft Windows

удовлетворяет одному из указанных ниже предустановленных заданных условий.
• Запускается
• Останавливается

Добавление триггера процесса
• Триггер службы. Запускает бот, когда статус указанной службы в Microsoft Windows

соответствует одному из указанных ниже заданных условий.
• Запускается
• Останавливается
• Возобновляется
• Приостанавливается
• Выполняется
• Остановлена
• Приостановлена

Добавление триггера службы
• Триггер окна. Запускает бот, когда указанное окно приложения удовлетворяет одному из

указанных ниже заданных условий.
• Открывается
• Закрывается

Добавление триггера окна

Discovery Bot

Новые возможности

УстановкаBot Agent без проблем
Если вы еще не установили программу Bot Agent, теперь вам будет предложено установить
Bot Agent с вкладки Процессы. Чтобы установить Bot Agent, следуйте инструкциям на
экране. После установки, чтобы продолжить запись, вам будет предложено включить
подключаемый модуль Chrome.

Необходимые условия для Discovery Bot

Усовершенствование автогенерируемых возможностей
Теперь можно начать просмотр автоматически созданной возможности вкладки
Возможности, когда для просмотра представлена хотя бы одна запись процесса.
Просмотрите автоматически сгенерированную возможность и при необходимости выберите
создание пользовательской возможности из возможности, сгенерированной автоматически.

Анализ возможностей, преобразование в бот и создание PDD
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Новые возможности

Новые записи для просмотра для пользовательской возможности
Теперь можно просматривать новые записи, представленные пользователем Discovery Bot
для пользовательской возможности. Вы можете принять или отклонить обновления записи в
рамках потока операций пользовательских возможностей. Этот параметр позволяет быстро
и легко просматривать новые записи в режиме реального времени по мере того, как записи
представляются пользователем для данного процесса.

Анализ возможностей, преобразование в бот и создание PDD

Усовершенствования на странице «Возможности»
Для того чтобы помочь просматривать и анализировать данные для потенциальной
возможности автоматизации, страница возможностей теперь обновлена и включает план
развития возможностей, а также другие графики. Используйте план развития возможностей,
чтобы определить, какие возможности следует автоматизировать в первую очередь.

Анализ возможностей для автоматизации

Загрузить документ PDD со страницы «Записи»
Теперь можно загружать и экспортировать документ PDD со страницы Записи. После
того как вы отправляете запись на рассмотрение аналитику, PDD автоматически начинает
обработку в фоновом режиме. При создании PDD поле изменяет значение с «Обработка PDD»
на Загрузить. Теперь вы можете выбрать загрузку документа в формате Word, PDF или в
обоих форматах. Также бизнес-пользователю на указанный в файле адрес электронной почты
отправляется уведомление. Загрузить документ PDD в формате Word или PDF также можно
для пользовательской возможности из таблицы со списком возможностей.

Анализ возможностей, преобразование в бот и создание PDD

Ограничения

В Community Edition и бесплатной пробной версии, если пользователь создает пять
процессов, а затем удаляет их, то при отправке записи для шестого процесса автоматически
генерируемая возможность работать не будет.
Обходное решение. Для создания новых процессов и возможностей создайте нового
пользователя Community Edition и бесплатной пробной версии.

IQ Bot

Новые возможности

Document Automation выпущенный в Community Edition
Community Edition теперь предлагает ограниченные возможности из версии Document
Automation. Эта версия интегрирована с Community Control Room. Когда вы создаете
обучаемый экземпляр, IQ Bot автоматически создает RPA боты для извлечения и загрузки
данных и процесс AARI для управления сквозным процессом. Валидация теперь происходит в
задачах AARI.
Используйте IQ Bot Community Edition для извлечения данных из счетов-фактур на
английском языке.
Community Edition
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Новые возможности

Усовершенствование классификатора
Теперь предусмотрена возможность создавать пользовательские группы документов в
обучаемом экземпляре. Это уменьшает вероятность того, что распознавание текста (OCR)
не сможет обнаружить поля в документе, что заставит классификатор создать группу
документов без необходимости или отправить документ в неправильную группу.

О классификаторе

Заметки Community Edition о выпуске Automation 360 v.22
Дата выпуска: 15 September 2021

Review the new features in the Community Edition of the Automation 360 v.22 (Сборка 10535) release.

Рабочая область RPA

Новые возможности

Introducing Text file пакет
A new Text file пакет is now available and includes the Get text action. Use this action to extract
text from files that have Japanese characters with Shift-JIS encoding and then save the content in
the files to a string variable.

Текстовый файл пакет

Share session across боты
Share a DLL, Excel, and Terminal Emulator session across multiple боты using the Global session
option. You can also share a session with specific child боты using the Variable option and share a
session with only the current бот using the Local session option.
Sharing sessions across боты

Усовершенствование AISense Recorder
AISense Recorder now enables automation of applications that use Russian and a combination of
Russian and English interfaces.
AISense для записи задач из удаленных приложений

Enhancements to recorder conditions for пакеты
• Use the new Object does not exist condition from the Condition list of any пакет to verify

whether a specific object in a window exists and then execute actions based on the result.
This condition works with SAP technology as well.

• The existing Object condition is now renamed as Object exists.

Цикл пакет
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Enhancements to Расширенный Excel пакет
• Open files with .xml and .txt extensions using the Open action.
• Use the wildcard character (*) in the Open action for file names to search based on the

wildcard pattern.
• When you use the Run macro action and specify an argument that has a blank value, this

blank value can now be passed to the macro.

New option in Database: Disconnect action
In the Database: Disconnect action, you can now use the Keep database schema in cache
until bot finishes running option to enable the Loop action to iterate the dataset by using
cached schema after disconnecting from the database.

Use regular expressions in Файл > Open action  (Service Cloud case ID: 00737614)
Use regular expressions (regex) in the Open action of the Файл пакет to support pattern-based
search.

Specify timeout for боты (Service Cloud case ID: 00667049, 00690892, 00699158, 00706491,
00739420, 00739415, 00741590, 00769795)
You can now specify the amount of time by which the execution of a бот must be completed. The
system stops the бот execution if it is not completed within the time you specified.

Настройте время ожидания выполнения для бот

New Exchange version supported in Эл. почта пакет
In the Эл. почта пакет, when you choose an EWS server to establish a connection, you can now
use the Exchange2013 option in the Exchange Version field.

Новое actions в пакет Окно
• Use the Close all action to close all windows or programs running on the system, except the

windows added in the Add window field.
• Use the Restore action to restore the size of a maximized or a minimized window or application

running on the system.

Окно пакет

New option to search text within бот content in Bot editor (Service Cloud case
ID: 00735685, 00736201, 00739122, 00740481, 00733885, 00748970, 00746459,
00738181,00756441,00759037,00761453,00764478)
In the Bot editor, use the search box in the Flow, List, or Dual view to search for text, variables,
or actions in the entire бот content such as package name, action name, string name, or variable
name. This feature helps you to view or edit a бот with long code lines to determine where the
searched text, such as variables, strings, or actions, is used and in which line.

Действия palette for бот creation

Enhanced support for Веб-служба SOAP URI (Service Cloud case ID: 00759811)
In the Веб-служба SOAP пакет, if the input to the Address location field is empty, the бот now
retrieves the address location from the WSDL file.
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Новые возможности

New option in Веб-служба SOAP пакет
Use the Build SOAP request option in the Веб-служба SOAP пакет to retrieve SOAP request
details from the SOAP URI or the WSDL file. You can now select any operations from the list of
services and ports available in the SOAP Request to automatically populate data in the fields of the
Веб-служба SOAP action.

Пример использования действия веб-службы SOAP

TNS name supported for Oracle Database connection
TNS (Transparent Network Substrate) name is now supported in the Oracle Database. You can
connect to the Oracle Database by specifying the TNS name and path of the tnsnames.ora
configuration file.

Wait time option in Google Таблицы пакет (Service Cloud case ID: 00738249, 00817449,
00814775)
When you use the Connect in the action in the Google Таблицы пакет to establish a connection
with the Google server, you can now set a wait time in the Wait for actions to complete field
when performing actions such as Get, Set, or Delete. For example, if you have a large file that
takes a long time to open, you can now set the wait time for the file to open before the system
executes the next set of actions.

New option for Put action in Словарь пакет
You can now assign a static value to a key for a dictionary variable by using the Static value
option in the Put action in the Словарь пакет.
Dictionary пакет

Relative click and occurrence supported in пакеты (Service Cloud case ID:
0055643,00754173)
When you capture a target image using the Распознавание изображений пакет, you can now use
the Preview option to select a specific captured occurrence and position your click location relative
to the image.
The feature is supported in the following пакеты and actions:
• Распознавание изображений > Find image in window
• Распознавание изображений > Find window in window
• Если > Image Recognition condition
• Цикл > While > Image Recognition condition
• Wait for condition action > Image Recognition condition

Using Find image in window action|Using the Find window in window action

Enhancements to execution type key in AATaskExecutor variable
• When you schedule a бот to run, the Execution_Type key in the AATaskExecutor variable now

returns information about the execution type with schedule type (frequency) such as Run as
 schedule Daily, Run as schedule Weekly, or Run as schedule Monthly.

• When you use a trigger in a бот, the Execution_Type key can be accessed through the
trigger data. The Execution_Type key returns the Run through Trigger as a string for
triggers.
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Language support for variable names
Variable names now support Greek and Japanese languages. You can now create variable names
using the following characters:
• Greek uppercase and lowercase characters
• Japanese Katakana full-width and half-width characters.

New option in Веб-служба REST (Service Cloud case ID: 00764198, 00800287)
In the Веб-служба REST пакет, you can now use the Allow insecure connection when using
https option to skip SSL certificate validation and to allow non-secure connections.

Work item ID and time filters for workload automations
Combine the work item ID and start time of a queue to search for specific work items and monitor
the progress of these work items. The start time filters the list of all work items that start between
specified start date and start time.
Actions allowed on view queue page

Enhancements to the бот structure
We have enhanced the overall readability of the бот structure and updated the node labels of the
бот to show selected properties and parameters of each action in detail in the Flow, List, and Dual
views. You no longer have to expand each action to view these details.
The Flow, List, and Dual views display the following properties of actions:
• The value you enter for actions such as Set text for all supported technologies
• Names of objects on which actions such as Set text, Click, Left click, Get property, and

Select item by index are performed
• Name of the object property mentioned in the action
• Name of the return variable if some value is assigned to a variable
• List of properties for the Get property action

Java applications supported in App integration пакет
The App integration пакет now supports Java applications that are based on the Standard Widget
Toolkit and Abstract Window Toolkit, which can draw text using Windows text-drawing APIs.

Direct download support in Bot Store
Users who cannot connect their Control Room to the internet can now directly download
Automation 360 боты and пакеты locally from Bot Store and then import them to their Control
Room.
Download locally and import боты and пакеты from Bot Store to Control Room
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AARI (Automation Anywhere Robotic Interface)

Новые возможности

Select File element input supported for Create a Request action
The Create a Request action in the AARI Web package now supports passing input in the request
creation forms for the Select File element. You can now use боты to create a request and upload
or download files as input with the Select File element. These input files are uploaded to the
storage service to be available for further processing in the request.

Output variables support in Process Editor
The Output variables section in the process editor enables you to create a user-defined variable
that can be set as an output to any process. This helps you pass the output from the child (sub)
process, which was called in the Process Task, to the parent (main) process.
Use an Output variable

Detail view in Tasks page
The new Detail view option in the Tasks page provides better insight into individual tasks for
better task management. The detail view previews each task in its respective request view page
without opening another page, which helps organize and correspond your tasks with the available
requests. Users can interact with their tasks as well.

Discovery Bot

Новые возможности

View Groups of steps
When reviewing a process view, you can now use the group option or icon to display groups
of steps that belong to the primary level action and secondary level action (and subgroup level
actions) used during the recording session.
Use the group icon to help you decide what groups of steps to select for a task you want to
automate. For example, a primary level action displays Microsoft Outlook, a secondary level action
displays Outlook mail notification, and subgroup level actions display terms such as Email -Add To,
Email – Add Subject.
Create a process view with branches and opportunities

Use Dynamic option for system-generated views
You can now use the Dynamic option from the Model options to view recordings where groups of
steps display a set of repeating patterns that belong to the same application or same primary level
action used during the recording session.
Use this option to decide the context of the process or the task you want to automate. Groups
of steps that are labeled belong to supported applications such as Microsoft (Excel, Outlook, and
Notepad), Notepad++, text editors, most windows use cases, and Chrome browser functionality.
Create a process view with branches and opportunities
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Новые возможности

Enhancements to PDD Word document
The PDD Word document now includes a process recording flow chart and the time on each
individual step in hours, minutes, and seconds.
Review opportunities and convert to

Previous Community Edition Release Notes
Review the release notes for previous Community Edition releases.

Заметки Community Edition о выпуске Automation 360 v.21

Дата выпуска: 02 июня 2021 года
Review the new features in the Community Edition of the Automation 360 v.21 (Сборка 9664) release.
• Рабочая область RPA
• AARI
• Discovery Bot

Рабочая область RPA

Важное замечание:  This release includes a required update to your . Ensure that you complete the
update to continue with your automation activities when upgrading from a previous release to this release.

Автоматическое обновление Bot Agent | Обновление Bot Agent вручную

To verify which  version is compatible with this release, see Compatibility with release builds.

Новые функции

Automation 360 navigation enhancements
We have enhanced the overall readability and accessibility of the Automation 360 interface. To
make navigation easier, menus and views are organized based on frequently used features and
related tasks.
The interface includes the following updates:
• The Device, Profile, and Help icons are now located at the bottom of the navigation menu,

consolidating all controls on the left for easy access.
When you click these icons, flyout panels of content and actions are shown.

• The side navigation menu can be collapsed to a slim bar to maximize the main workspace area.
You can continue to use the side navigation in collapsed mode, with flyouts for each section.

Automation 360 navigation updates
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Новые функции

Deploy workload automation on a multi-user Windows terminal server
To optimize workload automation and multi-user devices, you can deploy workload automations
on a multi-user Windows terminal server so that a single device can process multiple work items
concurrently.
About multi-user devices | About device pools

New actions in the SAP BAPI пакет
Use the following new actions:
• Run standard workflow: Runs a standard workflow in SAP BAPI.
• Run custom workflow: Runs a custom workflow in SAP BAPI.

пакет SAP BAPI

Новое actions в пакет Файл
Use the following new actions:
• Get name: Reads a file name and stores it to a string.
• Get path: Reads the path of the file and stores it to a string.

Файл пакет

Common table expression supported in База данных пакет
You can now use common table expression (CTE) in the Read from action using the WITH
keyword in SQL-compliant databases such as Oracle and MySQL. Use CTE statements within a SQL
query to simplify complex joins and subqueries.
Using the Read from action

Support for large numbers in Число пакет (Service Cloud case ID:00557619)
You can now perform mathematical operations for large numbers with more precision in the Число
пакет.

Число пакет

Snowflake database support using OBDC driver (Service Cloud case ID:00761695)
Snowflake OBDC driver is now supported in the База данных пакет. You can connect to the
Snowflake database using ODBC-based client applications.
The following actions support this feature:
• Подключить
• Отключить
• Прочитать из
• Экспортировать в таблицу данных
• Вставить/обновить/удалить

Variables: new features and enhancements (Service Cloud Case ID:00740585)
• Edit the variable name after the variable is created.
• Delete all or a specific selection of unused variables from a бот.

© 2023 Automation Anywhere. All rights reserved.     686



    Automation Anywhere - Learn

Новые функции

Universal Recorder new features and enhancements
• Record object interactions in applications built on the Electron framework.
• Perform double-click in all supported applications and browsers.

Limit credential attribute use to password fields only (Service Cloud Case ID:00740585)
When you create or edit a credential attribute, ensure that боты input the attribute value only in
fields that are identified as password fields by selecting the Set this attribute as a password
option.

Default names for output variables
When you configure an output variable for the actions in the Обработчик ошибок and Python
Script пакеты, the Control Room automatically generates a descriptive default variable name. If you
create more than one output variable for an action, the subsequent variable names are appended
with a -1, -2, -3, and so on to avoid a variable name conflict.

New string action to support nested variables
Use the String > Evaluate value action to compare a user-specified string variable with the string
variables in the бот. If a match is found, the action returns the value of the matching variable.

Строка пакет

Delete Global values
A user with the AAE_Администрирование role can delete a global value from the All global
values page.

Глобальные значения

ODBC driver support for all connection strings (Service Cloud Case ID: 00748887, 00777676)
An Open Database Connectivity (ODBC) driver is now available to support all the ODBC connection
strings in the same way it was used in the Enterprise 11 version. Using SQL as a standard for
accessing and managing data, you can connect to MySQL, Google BigQuery, Snowflake, and other
databases using the ODBC driver.

Share a DLL session
You can now share a DLL session between боты.

Automation Anywhere Robotic Interface (AARI)

Новые функции

Download, delete, or view files in browser in initial forms or tasks
Users can now use the Select File element to download files that are uploaded to the initial
forms or tasks, and they can also delete files or access the hyperlink file to view the file in within
the browser. The uploaded file can be accessed as a hyperlink, and new icons are available for
download and delete.
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Новые функции

Enhancement to team roles
The AARI team consists of three roles:
• Member: Can create, view, and delete their own requests. All the tasks are automatically

assigned to the member when they create the request in a private team. In a shared team, the
member can assign tasks to other members.

• Owner: Can create, view, delete, and assign all the requests from the members in the team.
• Admin: Can create, view delete, and assign all the requests from the members in the team. The

admin can also modify the team.

An AARI admin or manager can edit their teams and update their team members' roles. They also
have the option to add or remove team members. The AARI manager is the team admin by default
when they create a team.

Assign to me feature in tasks
When a task is unassigned and users access the tasks, use the Assign to me option to allow the
tasks to be assigned to the current user so that they can immediately access the form.
Assign or unassign a task

New Бот page
When AARI team members with attended Bot Runner licenses access the web interface, they are
automatically redirected to AARI Assistant. Users can view all the боты created by them on this
page. They can also pin, search, and sort their assigned боты.

New team reference in Request and Process pages
The user can now reference the team from which a request is created by referring to the new
Team column in the Request page or the team name added in the process tile in the Process
page, to help guide their team assignment.

New Request Visibility field (Service Cloud case ID: 00718119)
Request visibility enables users to allow or restrict access to a request they created to other team
members. When the Request Visibility field is set to Shared, all the requests are accessible by
all members, owners, and team admins. If the field is set to Private, the requests are available
only to the user who has created the request, owner, and the team admin.

Enhancement to the Processes page
The following enhancements are available on the Processes page:
• Sort the processes by name, in ascending or descending order.
• Toggle the pinning of a process.
• Use the responsive view to adjust the display to the screen size.

AARI Assistant for attended Bot Runner
The AARI Assistant application enables users with the attended Bot Runner license to access their
боты without logging in to the Control Room. AARI web users can use the AARI Assistant when the
attended Bot Runner license is enabled along with their AARI User license without impacting their
existing functionality.

Сведения о AARI Assistant
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Новые функции

Add rows from header row context menu
Only the header row is displayed when a form that has a table is launched during бот runtime. Use
one of the following methods to add new rows to the table:
• Header row context menu of the table

Использование элемента «Таблица»
• The Set action in a бот

Задать action

Discovery Bot

Новые функции

Sort for a process tile from the Processes page
You can now use the sort field to help you locate a process tile quickly. From the Processes page,
use the drop-down menu to sort on a process tile based on the process name in alphabetical order.
Alternatively, you can sort in the order of the newest process created to the oldest process and vice
versa.
Create a Discovery Bot process

Enhancements to opportunities
You can now review and analyze automatically generated (or system-generated) opportunities
immediately from the Opportunities page. Auto-generated opportunities are created when at
least two recordings are approved by the user. You can create a custom opportunity from an auto-
generated opportunity and apply the Model and Filter options to target a specific opportunity for
automation.
You can now prioritize opportunities based on a simple formula for all recordings in a process. From
the Opportunities table, you can view the cost without automation and savings for an opportunity.
The system automatically calculates the cost and potential savings for each opportunity generated.
You can customize these metrics based on your organization's model for cost and savings.
Review opportunities and convert to

Generated PDD files are available on your local server
The generated PDD file for an opportunity is now stored locally on your server for On-Premises
deployments. The existing PDD files are automatically moved to the new location and are not
deleted when a re-installation or upgrade is performed in the Control Room.

Необходимые условия для Discovery Bot

Заметки о выпуске Community Edition A2019.20

Дата выпуска:14 апреля 2021 года
Review the new features in the Community Edition A2019.20 release (Сборка 8846).
• Community Edition
• AARI
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• Discovery Bot
• Bot Insight

Community Edition

Важное замечание:  This release includes a required update to your . Ensure that you complete the
update to continue with your automation activities when upgrading from a previous release to this release.

Автоматическое обновление Bot Agent | Обновление Bot Agent вручную

To verify which  version is compatible with this release, see Compatibility with release builds.

Новые возможности

Automate SAP-related tasks using SAP BAPI
Use the actions available in the SAP BAPI пакет to automate SAP-related tasks using SAP BAPI.

пакет SAP BAPI

Default names for output variables
When you configure an output variable for the following пакеты, the Control Room shows a
descriptive default variable name. If you create several output variables, subsequent variable names
are appended with a -1, -2, -3, and so on to avoid duplication.
• Браузер
• CSV/TXT
• Эл. почта
• Расширенный Excel
• JavaScript
• Цикл
• Средство записи
• VBScript
• Окно

PDF split with blank pages supports scanned image documents (Service Cloud case ID:
00683923)
Use the PDF Split action to separate a blank page from pages with scanned images. With pixel-
based split, you can now use Split document to split a PDF with blank page separators for
scanned (image-based) documents.

SMTP port range expanded to include ports 1 through 65535
The Эл. почта пакет now supports ports in the range of 1 through 65535 for the SMTP server. You
can use the Send email action by configuring the SMTP port in this range.

New actions in the Active Directory пакет
• Update account options: Sets account attributes for the user.
• Change user password: Use this option to change a user's password.

User account operations
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Новые возможности

Enhancement to Create user action in Active Directory пакет
You can now use the Create user action to create an Active Directory user with password.
Using the Create user action

Universal Recorder expanded support and new features
Use the Universal Recorder to perform the following:
• Automate clicks and data retrieval in drop-down lists and combo boxes in Oracle EBS

applications such as Compass.
• Link an object that the бот cannot reliably identify to a nearby object (such as a link or button)

that is easier for the бот to find. Use this feature in MSAA, UI Automation, or Java applications.

Support for new languages in variable names
You can now use Czech, Danish, Dutch, Finnish, French, German, Hungarian, Italian, Norwegian,
Polish, Portuguese, Romanian, Spanish, and Swedish characters in variable names.
Unicode range supported in variables

Search and add child бот in the parent бот
Search for a child бот in the public and private workspaces so that you can add it in the parent бот.
You can search for the child бот from the Bot editor and the Run action of the TaskBot пакет.
Using the Run action | Bot editor for creating боты

Obtain information about user that deployed the бот
Use the AATaskInvoker system variable to return the username, first name, last name, and email
of the user that ran or scheduled the бот. If the бот is deployed to an attended Bot Runner, this
variable returns information about the logged-in user. If the бот is deployed by a trigger, this
variable returns information about the user who set the trigger.
System settings and parameters

New condition in If пакет (Service Cloud case ID: 00536088, 00690073,00717514, 00737243,
00702383)
Use the new Window with same title does not exist or Window with same title exist
condition available in the If пакет to verify whether a window with the same title exists or whether
the window title has changed.

Если пакет

Google пакеты are now generally available
Google Календарь, Google Диск, and Google Таблицы пакеты are now generally available in
Automation 360, and contain these new actions:
• Write from data table and Insert row/column actions in the Google Таблицы пакет.
• Each Google пакет contains a Connect action to authenticate your account before adding other

actions from that пакет to your automation. This action replaces the deprecated OAuth action
from the G-Apps пакет.

• Each Google пакет contains a Disconnect action to terminate the connection.

Using the Connect action for Google packages
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Automation Anywhere Robotic Interface (AARI)

Новые возможности

Get Storage file action
The new Get Storage file action in the AARI Web package enables you to download storage files
to a бот device.
AARI Web пакет

Upload files in initial forms or tasks
Add the Select File element to forms to enable users to select and upload files in the initial forms
or tasks in the web interface. Users can browse to upload a new file or replace an existing file. The
uploaded file is shown as a hyperlink and redirects users to a new tab when opened.

Настройка процессов

Hyperlinks support for initial forms or tasks
Use the new Hyperlink element to add links to forms and access them in initial forms and tasks.

Настройка процессов

Configure a scheduler user for each process (Service Cloud case ID: 00713786)
As an AARI administrator, you can now configure a scheduler user for each process to allocate the
Control Room resources (devices and unattended Bot Runner) on the web interface. By default, the
Global scheduler user is selected if a scheduler user is not configured for individual processes.
Configure scheduler user for AARI on the web

Update to properties panel for human task (Service Cloud case ID: 00718109)
As a Bot Creator, you can choose to not configure any actions in the human task by selecting the
Make the form read-only check box in the Properties panel. The human task does not require
any input and it is executed automatically to the next task.

Bookmark any page as landing page for AARI on the web
The web interface is now enhanced to a new multiple page system so that you can directly
bookmark any page (Requests, Tasks, or Recycle Bin) as your landing page. Also, the tabs
in the web interface have been removed so that the requests are opened one at a time and not
simultaneously. To perform multiple tasks, you can open the requests pages in different browser
tabs.

Navigation enhancement in AARI on the web
The web interface is now enhanced with a side navigation pane so that you can easily navigate to
various pages (Processes, Requests, Recycle Bin, and Tasks).

New processes page (Service Cloud case ID: 00694786)
As an AARI user, navigate to your assigned processes and create new requests by using the new
Processes page in the web interface. Use the navigation bar to quickly access the page.
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Новые возможности

Enhancements to the Button element
• Use the Disallow button click when this form is first loaded option to disable the Button

element in a form when it is displayed for the first time during бот runtime.
• Use the Subtle option in the Button type drop-down menu if you want the button element to

appear as a link during бот runtime.

Использование элемента «Кнопка»

Усовершенствование логотипа формы
You can now use the Logos in footer field option to select up to two separate logos that are
displayed in the footer of the form during бот runtime.
Create a form

Discovery Bot

Новые возможности

Search for a business process from the Processes page
You can now use the search field to help you locate a specific process by name. The field is not
case-sensitive. The search field is available from the Processes page.
Create a Discovery Bot process

View all captured images from the screenshot modal window
You can now navigate across all captured screenshots when you click an image in full size from the
modal window. Щелкните разбивку на страницы, расположенную под изображением, чтобы
выбрать номер шага, или используйте стрелки вправо или влево для быстрого отображения
всех созданных изображений.

Запись бизнес-процесса Discovery Bot

Process Discovery package is included in default packages
The Process Discovery package is now included in the default packages. При подключении к
устройству можно предварительно загрузить пакет по умолчанию. Preloading the package
helps to speed the start time of the recorder the first time you begin recording a process

Необходимые условия для Discovery Bot

Recorder enhancements
You can now perform actions such as double-click, drag-drop, click and hold, and text select
when recording a business process. Действия, выполняемые с помощью нажатий клавиш,
отображаются в поле Данные. Double-click is captured by the recorder and displayed in the
screenshot from the Recordings page.

Прим.:  The Discovery Bot recorder does not capture the drag-drop and click and hold actions
from the Recordings page. To include these actions performed during the recording, you can
document the individual steps in the Step description text field for the analyst.

Запись бизнес-процесса Discovery Bot
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IQ Bot

Известные ограничения

IPv6 addresses are not supported for IQ Bot, so ensure that you use only IPv4 addresses.

Bot Insight

Новые возможности

AAE_Admin role access to operations API from Power BI connector
The Power BI connector now provides the AAE_Admin user role access to the botrundata
operational API. With this role, you can connect to the botrundata API and extract operational
metrics to be analyzed and visualized within Power BI.

Enhancements to the publish (production) dashboard
Users with the AAE_Bot Insight Admin and AAE_Bot Insight Expert role can now edit the
published dashboard. You can use the save as option to save the production dashboard as a custom
production dashboard and add widgets to your custom dashboard. You can also delete a default
production dashboard and a custom production dashboard.
Save a published dashboard | Delete a published dashboard

Важное замечание:  The supported packages information is moved to this topic: View пакет versions
available in the Control Room.

Заметки о выпуске Community Edition A2019.19

Дата выпуска: 05 February 2021

Review the new features in the Community Edition A2019.19 release (Сборка 8145).
• Community Edition
• AARI
• Discovery Bot

Community Edition

Важное замечание:  This release includes a required update to your . Ensure that you complete the
update to continue with your automation activities when upgrading from a previous release to this release.

Автоматическое обновление Bot Agent | Обновление Bot Agent вручную

To verify which  version is compatible with this release, see Compatibility with release builds.

© 2023 Automation Anywhere. All rights reserved.     694



    Automation Anywhere - Learn

Новые функции

New features in Таблица данных пакет (Service Cloud case ID: 00656843, 00707635)
• Use the Change column type action in the Таблица данных пакет to perform operations

on the column of a data table. Use this action to change the column data type to Boolean,
Datetime, Number, or String.

• Sort the data in the data table in Number, Datetime, Boolean, or String format.

Таблица данных пакет

Новое action в пакет Интеграция приложений
Use the Capture scrollable text action to extract text from the selected window or any control
within the selected window and save it to a variable. If you click any control within the window,
then text from that specific control is extracted. If you click outside the window, then all the text
from that window is extracted.

Интеграция приложений пакет

New encoding combo box option in Эмулятор терминала for VT Series
To send and receive Japanese text, you can now use the Encoding and CodePage combo boxes
when you connect to the Terminal Emulator for the VT series terminal type.
Using Connect action for Эмулятор терминала

New actions in Active Directory пакет
Use the following actions in the Active Directory to automate a task:
• Move a computer

Using the Move computer action
• Move an organizational unit

Using the Move organizational unit action
• Add users to a group

Using the Add users to group action
• Remove users from a group

Using the Remove users from group action

New system variable for new line character (Service Cloud case ID: 00669232, 00672775,
00673578)
Use the $String:Newline$ system variable to add a new line character. This variable adds a new line
character in various applications regardless of the operating system of the device.

Zero-size form for Enterprise A2019 (Service Cloud case ID: 00677611)
The Run action uses the zero-size form with name AAZeroSizeForm that can be used by DLLs to
identify zero-size forms created by Enterprise A2019.

Enhancement to define parent path in Active Directory
When you establish a connection with an LDAP server, you can now select the LDAP path by
connecting to the server.
Using Connect action for Active Directory
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Новые функции

Obtain information about Run-As user after бот deployment
Use the AATaskExecutor system variable to return the username, first name, last name, and email
of the user that ran the бот. If the бот is deployed on an attended Bot Runner, this variable returns
information about the logged-in user. If the бот is deployed by a trigger, this variable returns
information about the user associated with that Bot Runner license.
System settings and parameters

Enhancements to the Средство записи
• Universal Recorder now supports object capture in Mozilla Firefox.

You must install the A2019 extension from Mozilla Firefox browser add-ons.
• Capture table, grid view, and main window objects from SAP applications.

Universal Recorder supported applications and browsers | Actions performed on objects captured with
Universal Recorder

Automation Anywhere Robotic Interface (AARI)

Новые функции

New filter task in the process editor
In the process editor, the Filter Task enables users to filter variables such as human or бот task
output with a specific filter criterion.

Создание процесса AARI

New process task in the process editor
Use the new Process Task option in the process editor to call a subprocess within the main
process. This feature enables you to separate tasks into different processes instead of including
all the tasks in a single process. Multiple teams can now work at the same time on different tasks
within the main process and remain segregated, without any conflicts.

Создание процесса AARI

Hide a task or view a hidden task
With a Bot Creator license, you can now perform the following:
• Hide the display of human and бот tasks by selecting the Hide this task after completion

option in the process editor.
• View a hidden human or бот tasks by selecting the View hidden tasks option in the tasks view

page.

Создание процесса AARI

Edit title in process editor
Users can now edit the title in the process editor.

Rich-text editor updates (web interface)
In the web interface, you can use rich-text editor features such as bold text, italics, underline,
alignment, formatting, color, and size in tasks.
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Новые функции

Table element updates (web interface)
In the web interface, the Table element now supports the use of date, number, drop-down, and
text values in tasks.

Updates to elements in form builder
The form builder now includes the following new elements:
• Select Folder element: Add an upload folder option in the form.

Using the Select Folder element
• Hyperlink element: Assign a URL in the form.

Using the Hyperlink element

Enhancement to the Checkbox action trigger
If a form with a Checkbox element is used within a trigger loop пакет, you can now use the
Value selected and Value unselected trigger actions.
Trigger loop пакет

Discovery Bot

Новые функции

View the duration of each recorded step
A recorded step is now displayed in minutes and seconds for the business user and analyst. Use
this information to understand which steps are a bottleneck in the current process and will provide
most benefit from automation. The step duration is displayed from the Recordings page (below
the screenshot image), and from the View process and View opportunities page from the
Preview pane window.

Запись бизнес-процесса Discovery Bot

Важное замечание:  The supported packages information is moved to this topic: View пакет versions
available in the Control Room.

Заметки о выпуске Community Edition A2019.18

Дата выпуска: 05 January 2021

Review the new features and supported packages in the Community Edition A2019.18 release (Build 7560).
• Community Edition A2019
• AARI
• Discovery Bot
• Bot Insight
• Supported packages
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Community Edition A2019

Важное замечание:  This release includes a required update to your . Ensure that you complete the
update to continue with your automation activities when upgrading from a previous release to this release.

Автоматическое обновление Bot Agent | Обновление Bot Agent вручную

Сборка 7560 (Community Edition) is compatible with Bot Agent 16.19.8232.

Новые функции

Configure timeout in Бот Migration пакет
When migrating боты, you can now set a timeout value in the range of 3 through 90 minutes
(default value is 90 minutes). If the migration of any specific бот is not completed within the set
time, a timeout message is displayed and the migration process moves to the next бот.

Use regular expressions in variables (Service Cloud case ID: 00628227)
Use regular expressions (regex) in value type variables to specify the entity on which you want to
perform an operation. For example, actions in the Файл, Папка, Строка, and Окно пакеты allow
use of regular expression in variables.
When Enterprise 11 or Enterprise 10 боты with commands that use regular expressions in variables
are migrated, if their equivalent actions in Enterprise A2019 do not support regular expressions, the
regular expression is converted to string in the migrated боты.

Средство записи enhancements
• Use the AISense Recorder Define option to record an interaction, such as click active text, with

an object that is only visible when you hover the mouse over the object.
• If you record a click and keystrokes in a text box with a Control Type of PASSWORD_TEXT,

the Recorder does not capture the keystrokes entered into the field. Instead, the action selects
the Set text option and offers users the option to select a credential from the Credential Vault,
enter a credential variable, or enter an insecure string.

Efficiently map input and output variables between parent and child боты (Service Cloud
case ID: 00537090, 00698697)
For input variables, use the Quick map option to select the variables and set the values for
the parent бот to pass. For output variables, use the Multiple variables tab to associate each
dictionary key with a variable. This feature eliminates the need to use actions to extract the output
dictionary values.
TaskBot пакет | Using the Run action

Support for PowerBuilder application in Интеграция приложений пакет (Service Cloud
case ID: 00680703)
The Интеграция приложений пакет now supports PowerBuilder to capture and extract text from
a window application. The Capture text of window action enables you to open a PowerBuilder
screen to capture all the data and verify the captured text.

Новое action в пакет Эмулятор терминала
Use the Search Field action in the Эмулятор терминала пакет to search for a field based on the
text it contains. This action returns the name or index of the field based on the option selected.
Terminal Emulator пакет
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Новые функции

Новое action в пакет PDF
Use the Get Property action in the PDF пакет to retrieve the properties of a PDF file and assigns
the properties to a dictionary variable.
Using the Get property action

Новое actions в пакет Браузер
Use the following actions in the Браузер пакет:
• Close: Closes a Google Chrome browser window or tab.
• Get source code: Извлекает исходный код веб-страницы и сохраняет его в строковой

переменной.
• Go back: Возврат на веб-страницу, которую вы ранее посетили на текущей вкладке.
• Open: Opens the browser to a specific web page in an existing tab, new tab, or window.
• Run JavaScript: Executes JavaScript in a web page.

Браузер пакет

Specify application window dimensions
Use the Resize windows option to set the window height and width to specific dimensions or
to the dimensions at which it was captured. This feature enhances the bot's ability to identify the
target object.
The following пакеты support this feature:
• Интеграция приложений
• Если Image recognition condition
• Если Legacy Automation > Window Control condition
• Распознавание изображений
• Имитация нажатия клавиш
• Legacy Automation Desktop > Manage windows controls action
• Цикл While > Image recognition condition
• Цикл While > Legacy Automation > Window Control condition
• Мышь
• Распознавание текста (OCR)
• Экран

Support for function keys in Эмулятор терминала пакет
Function keys (F1 through F24) are now supported to automate processes using ANSI and VT100
terminals in the Эмулятор терминала пакет.
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Новые функции

Use regex case insensitive flag for Window title
Enable the regex Case insensitive flag to identify a Window title field as not case-sensitive.
This feature enables you to successfully run the боты even if the letter case does not match the
captured window title.
The following пакеты and actions support this feature:
• Ожидать
• Распознавание изображений
• Имитация нажатия клавиш
• Мышь > Click action
• Legacy Automation Desktop > Manage windows controls
• Распознавание текста (OCR) > Capture window, Capture area
• Экран > Capture window, Capture area
• Средство записи > Capture
• Окно: Activate, Close, Maximize, Minimize, Resize

Automation Anywhere Robotic Interface (AARI)

Новые функции

New AARI on the web пакет
Use the AARI on the web пакет to perform actions such as assign, query, and cancel tasks; create
and query requests; and retrieve a list of team members.
AARI Web пакет

Filter by time
You can now filter your requests and tasks by time:
• Requests tab: Use the Created and Updated options in the Filter window to select any

dates.
• Tasks tab: Use the Task created and Task updated options in the Filter window to select

any dates.

Filter and search for a request | Фильтрация и поиск задач

View updated dates
• Use the new Updated column in the Requests tab to view the dates and time of a request

that was last updated.
• Use the new Task Updated column in the Tasks tab to view the date and time of a task that

was last updated.

Variable options
In the Insert a variable window, the Variable field now shows child elements of available
references, which include Dictionary, List, Record, and Table variable types.
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Новые функции

Delete a request
AARI administrators, managers, and users can now delete requests created by the AARI process.
The AARI administrator can delete any requests. AARI managers can delete requests of the team
for which they are the owner. AARI users can delete only the requests they have created.
Delete a request

Automatically assign managers and users
Users can now select the Auto assign this task option in the Human Task to assign managers
or users to the task. Users can also select the Auto assign the target task to option in the Go
to element to assign managers to the task.

Создание процесса AARI

Discovery Bot

Новые функции

Access Discovery Bot capabilities in Community Edition
Discovery Bot is now available in the Community Edition and the free trial version. Log in to the
Control Room and click the Discovery Bot tab on the left panel to get started.
The available limits to create processes, recordings, views, and opportunities are displayed on
the respective page. Create any number of боты and download a PDD for your personal use as
required.
A single Community Edition user is a multi-role user with Admin plus Business user plus Analyst
permissions.

Начните с Discovery Bot

Use Model option for system-generated views
You can now use the Model option to compare and find the best aggregated view for your
recordings. Use this option to save as many views with different combinations as required.
You can also save the view as a manual view to further customize your view and compare side-by-
side. Select either an Easy or Strict model so that you can view recordings where the steps are
the same versus recordings with different results with more branches in the process path.
Create a process view with branches and opportunities

Use Filter option for system-generated views
You can now use the Filter option to use a set of values to compare different sections of a process
across various recordings by selecting a specific path and step filter. Used along with the Model
option, the path and step filter options for a system-generated or manual view can help you to
determine and decide on a good candidate for automation.
Create a process view with branches and opportunities
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Новые функции

Use toggle frequency counter option for system-generated views
You can now use the toggle frequency counter to display the number of recordings that a particular
path takes in the flow in a system-generated view. Use this option to help you understand the
frequency of the path compared to other recordings or views.
Create a process view with branches and opportunities

Remove recording screenshot for data privacy
Use the Screen option (icon) to display or hide the recording screenshot before submitting the
recording for the analyst to review. Use this option when you do not want to share personal image
details with the analyst.

Запись бизнес-процесса Discovery Bot

Download PDD from the Opportunities table
You can now download a process definition document (PDD) for an opportunity directly from the
Opportunities table listed on the Opportunities page. The PDD is automatically generated when
the opportunity is created. After the PDD is generated, the field changes from generating PDD to
Download PDD. You can then download and save the document.
Review opportunities and convert to

Bot Insight

Новые функции

Access Bot Insight data from Tableau
Use the Tableau connector in Bot Insight to access business and operational information. The
Tableau connector connects to the Bot Insight APIs to create various business and operational
metrics that you can analyze and visualize within Tableau.
Configure Tableau web data connector in Bot Insight

Поддерживаемые пакеты

Пакет Версия

Приложение 2.1.0-20201112-22332

Интеграция приложений 2.3.0-20201210-171315

Active Directory 2.1.0-20201112-223323

Логический 2.1.0-20201126-165109

Браузер 2.3.0-20201211-222811

Буфер обмена 2.1.0-20201126-165124

Комментарий 2.3.0-20201126-165125

CSV/TXT 2.3.0-20201126-165126
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Пакет Версия

База данных 2.2.0-20201112-223343

Таблица данных 2.5.0-20201201-130615

Дата/время 2.2.0-20201126-165136

Задержка 2.2.0-20201126-165137

Словарь 3.2.0-20201126-165138

Run DLL 3.3.0-20201126-165850

Эл. почта 3.2.0-20201120-062604

Обработчик ошибок 2.3.0-20201126-165148

Базовый Excel 2.4.0-20201126-165604

Расширенный Excel 5.3.0-20201208-090251

Файл 3.2.0-20201126-165151

Папка 3.1.0-20201126-165154

FTP / SFTP 2.2.0-20201115-072759

Распознавание изображений 2.2.0-20201117-081754

JavaScript 2.4.0-20201126-165412

Имитация нажатия клавиш 2.5.0-20201112-223902

Legacy Automation 3.2.0-20201124-064544
1.5.0-20201125-004358

Список 2.2.0-20201126-165427

Записать в файл 2.2.0-20201126-165428

Цикл 2.1.0-20201126-165429

Message Box 2.1.0-20201126-165430

Мышь 2.2.0-20201112-223917

Число 2.1.0-20201126-165444

Распознавание текста (OCR) 2.3.0-20201126-081210

Office 365 Excel 2.2.0-20201104-062559

Календарь Office 365 2.1.0-20201111-162101

Office 365 OneDrive 2.2.0-20201126-165550

PDF 2.6.0-20201126-165555

PGP 2.2.0-20201126-165557

Ping 2.1.0-20201126-165559

Воспроизвести звук 2.1.0-20201127-115706

Запрос 2.2.0-20201109-192507

Python Script 2.4.0-20201208-064944
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Пакет Версия

Средство записи 2,10-20201215-211402

Веб-служба REST 3.2.0-20201112-224735

SAP 2.2.0-20201126-165852

Экран 2.2.0-20201126-165855

SNMP 2.1.0-20201126-165859

Веб-служба SOAP 3.2.0-20201123-093411

Строка 3.1.0-20201126-165909

Система 3.0.0-20200921-090225

Эмулятор терминала 3.6.0-20201213-084139

VBScript 2.4.0-20201208-065526

Ожидать 3.1.0-20201126-165922

Окно 2.3.0-20201123-093430

Рабочая нагрузка 2.1.0-20200825-071644

XML 2.1.0-20201126-165927

Заметки о выпуске Community Edition A2019.17

Дата выпуска: 13 November 2020

Review the new features and supported packages in the Community Edition A2019.17 (Сборка 7103)
release. IQ Bot is on Build 7082.
• Community Edition A2019
• AARI
• IQ Bot
• Bot Insight
• Supported packages

Community Edition A2019

Важное замечание:  This release includes a required update to your . Ensure that you complete the
update to continue with your automation activities when upgrading from a previous release to this release.

Автоматическое обновление Bot Agent | Обновление Bot Agent вручную

Новые функции

Connect to EWS server with OAuth authentication
A new authentication is available for the Exchange Web Services (EWS) protocol with OAuth.
You can use the OAuth authentication and enable your EWS-managed API applications to access
Exchange online in Office 365.
Using Connect action for Эл. почта
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Новые функции

VT220 terminal type supported in Эмулятор терминала
To establish a connection and communicate with another machine, you can now use the VT220
terminal for sending and receiving text.
Using Connect action for Эмулятор терминала

Enhancements to the Средство записи
• Record a task using the Universal Recorder or AISense Recorder from a single point of entry.

Both recorders are now managed through a single пакет, which enables faster and more
efficient updates.

• You can now record tasks in a Microsoft Edge browser that runs on Chromium (versions 79 and
later).

• Use the AISense Recorder Define option to capture an object that is only visible when you
hover the mouse over the object.

• Use the Resize window option in the Recorder > Capture action to set the window width
and height.
This option delivers a more reliable бот. It resizes the window to the dimensions at which the
task was recorded, thus increasing the likelihood that the бот identifies the target object.

Get started with recorders | Universal Recorder supported applications and browsers | Using the Capture
action

Use shared session in Эмулятор терминала
Use the new Shared session option to pass the exact state of an application to a concurrently
occurring TaskBot or MetaBot logic. For example, instead of connecting to the same application
multiple times for different tasks, you can use the option to connect to the application using a
single task, thus optimizing your automation logic in the long run.
Share session between TaskBot logic

Share an Excel session between боты
Use the Set session action from the Базовый Excel or Расширенный Excel пакет to assign an
Excel session to a variable, and then pass that variable from a parent to a child бот. This enables
the child бот to access the worksheet opened in the parent бот.

Базовый Excel пакет | Excel advanced workbook operations | Example of sharing an Excel session
between bots

New option for Выполнить задачу
In the TaskBot пакет, you can now use the Run action with an option to repeat the selected task
until you choose to stop it.

New search for roles in User Management API
Use the new Search for roles API in the User Management APIs in Swagger to obtain a list of
all the roles or details for a specific role.

Capture response status of REST API
In the Веб-служба REST пакет, you can capture the response status of the REST API in the
dictionary variable. The dictionary variable now shows the response key with its value.
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Новые функции

New option for Веб-служба REST (Service Cloud case ID: 00489741, 00646436)
Use the Capture failure response action in the Веб-служба REST пакет to capture response
details in the response body.

Use regular expressions in пакеты
You can use regular expressions (regex) in certain actions to support pattern-based search in a file,
folder, or Windows title. Regular expressions are supported in the actions of the Файл and Файл и
папка пакеты such as Copy, Delete, Rename, Print Multiple files, and Zip.
You can also use regular expressions in some пакеты that support the wildcard character in their
window titles.
The following пакеты and actions support regular expressions:
• Ожидать
• Распознавание изображений
• Имитация нажатия клавиш
• Мышь > Click action
• Legacy Automation > Manage windows control
• Распознавание текста (OCR)
• Экран
• Средство записи > Capture
• Run DLL > Run function (Legacy), Run function
• Окно: Activate, Close, Maximize, Minimize, Resize

Using Copy Desktop file action for file | Using the Capture action

Support for overloaded functions in DLL пакет
The DLL > Run function action can now handle .dll files that contain multiple functions of the
same name. The action calls the function based on the number of parameters passed.

Использование action «Выполнить функцию»

New actions for SAP captured objects
Use new actions that are available for Tree, Tab, and Label controls to perform operations for the
various objects captured from an SAP application.

Средство записи actions supported in various SAP versions

Store multiple lines of text in a string variable
You can use a string variable containing multiple lines of text in the following actions:
• String > Assign
• String > Extract text
• String > Compare
• String > Lowercase
• String > Replace
• String > Reverse
• Log to file
• Message box
• The string condition in the If, Wait, and While actions
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Новые функции

Arabic, Japanese, and Russian characters supported in variable names
You can now create variables with names containing Arabic or Russian characters, or Japanese
double-byte numbers.
Unicode range supported in variables

Automation Anywhere Robotic Interface (AARI)

Новые функции

View previous selected tasks
AARI users can now reference selected actions of their tasks. When they view a submitted task in
request view, a check mark indicator is now displayed next to the buttons that are selected.

Run a process in private workspace
You can now run a process in your private workspace by using the Run option in the process editor.
The боты in the process are then executed on the default device of the Bot Creator.

Настройка процессов

Use variables types
You can now use new variables in the process editor such as createdOn and updatedOn
(DateTime), id (Number), and title (String). These variables are part of a data flow (workflow
engine) that moves data between each step of a process and requires variable input for the process
to run properly.
AARI variable types

Use the Data Privacy tag field
The Data Privacy tag enables users to generate hidden custom output in their process tasks
(Start panel, Human Task, and Bot Task). Users can enter the variables for this field during
runtime with values. In the web portal, the AARI admin can use this tag to check for requests or
tasks by using personal user data. The admin can also filter using this field.

Создание процесса AARI | Filter and search for a request | Фильтрация и поиск задач
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IQ Bot

Новые функции

Support for Arabic language
When creating a learning instance, you can now choose the Arabic language from the Primary
language of documents drop-down menu, with the following limitations:
• Advance table extraction is not available.
• Search field on the Валидатор is not supported.
• Arabic numerals are not supported.

For example, if the document has date or time in Arabic language, it is extracted as text and
validations can fail.

Прим.:  You can still use string-based validation checks (such as regular expressions) for Arabic
numerals.

• Arabic is only supported on ABBYY FineReader Engine 12.4.

Creating a learning instance

Default validations for a group
When editing a learning instance, you can now use the Select the default validations group
drop-down menu to select an available group. This allows all the new group documents in
production to be extracted based on the custom logic and validations defined in this selected group,
before it goes to the Валидатор.
Edit a learning instance

Исправленные функции

ID обращения к облачному сервису Описание

- You can now create and edit a бот even if a document
associated with a deleted бот appears in production.
Previously, if a бот was deleted and a document
associated with it appeared in production, you could
not create a new бот.

Bot Insight

Новые функции

New AARI dashboard in Bot Insight
Use the AARI dashboard to view various widgets that provide information about requests created
from published processes in AARI. The dashboard also provides statistics on the status of created
requests.
AARI dashboard
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Поддерживаемые пакеты

Пакет Версия

Приложение 2.1.0-20200921-085720

Интеграция приложений 1.1.0-20201014-042506

Анализ 2.2.4-20200903-113949

Active Directory 2.1.0-20200921-085716

Логический 2.1.0-20201014-042509

Перенос ботов 2.5.0-20200902-045043

Браузер 2.1.0-20201002-123733

Буфер обмена 2.1.0-20201014-042520

Комментарий 2.2.0-20201014-042520

CSV/TXT 2.3.0-20201014-082525

База данных 2.2.0-20201013-052941

Таблица данных 2.3.0-20201030-143334

Дата/время 2.2.0-20201014-042531

Задержка 2.2.0-20201014-042532

Словарь 3.2.0-20201014-042532

Run DLL 3.2.0-20201105-205159

Эл. почта 3.1.0-20201104-062204

Обработчик ошибок 2.2.0-20201014-042541

Базовый Excel 2.3.0-20201027-160012

Расширенный Excel 5.1.0-20201027-155758

Файл 3.1.0-20201016-065515

File & folders 1.1.0-20201023-202725

Папка 3.0.0-20201016-065517

FTP / SFTP 2.1.0-20200921-085757

IF/ELSE 2.1.0-20200921-085758

Распознавание изображений 2.1.0-20201014-042552

Интерактивные формы 2.17.3-20201102-103733

IQ Bot 2.1.0-20201013-095304

JavaScript 2.3.0-20201104-062431

Имитация нажатия клавиш 2.4.0-20201021-163833

Legacy Automation 3.2.0-20201104-062439
1.3.0-20201105-151906
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Пакет Версия

Список 2.2.0-20201014-042806

Записать в файл 2.2.0-20201014-042806

Цикл 2.1.0-20201014-042808

Message Box 2.1.0-20201014-042808

Миграция 2.7.0-20201106-072418

Мышь 2.1.0-20201014-042814

Число 2.1.0-20201014-042823

Распознавание текста (OCR) 2.2.0-20201104-062503

Office 365 Excel 2.2.0-20201104-062559

Календарь Office 365 2.1.0-20200921-085726

Office 365 OneDrive 2.1.0-20201014-042924

PDF 2.5.0-20201014-042929

PGP 2.2.0-20201014-042931

Ping 2.1.0-20201014-042932

Принтер 2.1.0-20200921-090131

Воспроизвести звук 2.1.0-20200921-090123

Запрос 2.1.0-20200918-081201

Python Script 2.3.0-20201105-204912

Средство записи 2.0.9-20201105-164103

Веб-служба REST 3.1.0-20200928-231420

SAP 2.2.0-20200921-090209

Экран 2.1.0-20201014-043037

SNMP 2.1.0-20201014-043041

Служба 3.0.0-20200921-090214

Веб-служба SOAP 3.1.0-20200921-090219

Строка 3.1.0-20201014-043052

Система 3.0.0-20200921-090225

Задача 2.0.1-20201023-202703

Эмулятор терминала 3.4.0-20201028-021451

Trigger Email 1.1.0-20201105-152220

VBScript 2.3.0-20201105-205228

Ожидать 3.1.0-20201014-043117

Окно 2.2.0-20201022-121649

Рабочая нагрузка 2.3.0-20201105-205233
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Пакет Версия

XML 2.1.0-20201014-043121

Sandbox environment
The sandbox environment for Automation 360 Cloud enables you to test your production боты to ensure
that these боты work seamlessly in your production environment. Use the sandbox environment to help
plan and test new features for upcoming Automation 360 releases.
The sandbox environment is the same as any Automation 360 Cloud instance but includes updates from
the upcoming new release at least 3 weeks before Automation Anywhere Cloud is updated.

Note:  The sandbox environment should not be used as your production environment.
IQ Bot не входит в среду песочницы.

The following image shows how a new build is tested in the sandbox environment before it is pushed to
the production environment.

Преимущества

The environment provides the following benefits to the Automation 360 Cloud customers:
• Test new features and identify any changes that might be required in your current bots.
• Предварительный просмотр предстоящих функций и улучшений.
• Более эффективное планирование изменений и управление ими для предстоящего обновления

вашей среды.

Среда песочницы доступна только для облачных и поддерживающих облако развертываний
Automation 360. The environment is not supported for a Control Room in a data center that is hosted by
you or a third-party vendor. The environment includes upcoming updates for Automation 360, Discovery
Bot, Document Automation, AARI, and Bot Insight.
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Предварительные условия

• You must have a valid Automation 360 Cloud license to use the sandbox environment.
• Вы должны приобрести заказываемый артикул SKU песочницы.

Для получения более подробной информации обратитесь к менеджеру-консультанту (CSM) или
менеджеру по работе с партнерами (PEM).

Настройка среды

Перед началом использования среды сделайте следующее.
1. Отмените назначение нескольких лицензий существующим экземплярам Automation 360 и

назначьте эти лицензии среде песочницы.
2. Switch Bot Agent to the sandbox environment.
3. Создайте необходимых пользователей, функции и другие объекты Automation 360 Cloud в среде:

• Create a user on page 2699
• Create a role on page 2708
• Credentials and ячейки in the Credential Vault on page 2855

4. Export боты from your existing Automation 360 Cloud.
5. Import the exported боты to the sandbox environment using Bot Lifecycle Management.

See also:
• Automation 360 software lifecycle policy on page 746
• Automation 360 Cloud updates on page 760

Automation 360 Package SDK Release Notes
Review the new, changed, fixed, and deprecated features, and security fixes, known issues, and limitations
for the Automation 360 (formerly Enterprise A2019) Package SDK.
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Усовершенствования в Automation 360 v.27

Функция Описание

Added new annotations Added documentation_url and tutorial_url in
CommandPkg.
1. documentation_url - Use this to add a

documentation link to an action.
2. tutorial_url - Use this to add a video

tutorial link to an action.
Пример.

@CommandPkg(
        node_label =
 "[[CMtoINCH.node_label]]",
        label =
 "[[CMtoINCH.label]]",
        description =
 "[[CMtoINCH.description]]",
        name = "CMtoInch",
        icon =
 "ruler_icon.svg",
        documentation_url =
 "https://example.com/doc/
CMtoINCH.html",
        tutorial_url =
 "https://example.com/
tutorial/CMtoINCH.html",
       
 minimum_controlroom_version =
 "13980",
       
 minimum_botagent_version =
 "21.210")

A360-package-sdk-2.6.1.zip

Усовершенствования в Automation 360 v.25

Функция Описание

Добавлено значение по умолчанию
session_value

Добавлено значение default_session_value
в CommandPkg для установки значения по
умолчанию для глобального сеанса.

A360-package-sdk-2.5.0.zip
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Усовершенствования в Automation 360 v.23

Функция Описание

Версия Log4j Обновление версии Log4j до 2.17.1.

A360-package-sdk-2.4.1.zip

Усовершенствования в Automation 360 v.22

Функция Описание

Ребрендинг названия пакета Название пакета изменено с A2019 на A360.

Добавлены настройки возврата Добавлены настройки возврата для
CommandPkg для определения настроек или
конфигураций, связанных с типом возврата
команды.

Добавлена новая аннотация Добавлена новая аннотация для
SessionObject, указывающая на то, что в
команду передается объект сеанса.

Добавлена новая аннотация Добавлена новая аннотация для
SessionAllowNonExistent, указывающая
на то, что в команду может быть передан
несуществующий сеанс.

Добавлен новый тип атрибута Добавлен новый тип атрибута BAPIOBJECT
который работает с типом управления под
названием BAPIWORKFLOW, со следующими
тремя таблицами.
• Импортировать
• Экспорт
• Таблица

Добавлены настройки множественного
возврата

Добавлены настройки множественного
возврата в CommandPkg для возврата
нескольких значений из команды.

Обновления библиотеки среды выполнения В комплект поставки входят последние
библиотеки среды выполнения бот.

A360-package-sdk-2.3.0.zip

Усовершенствования в Automation 360 v.21

Функция Описание

Добавлена новая аннотация Добавлена новая аннотация для Control Room
и Bot Agent.
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Функция Описание

Добавлена новая аннотация Добавлена новая аннотация
для пароля учетных данных
(@CredentialAllowPassword).

Добавлен новый пример Добавлен новый пример в папку 
 botcommand/samples/commands/
basic/types, файл под названием
CredentialTypeDemo.java.

Добавлена новая аннотация Добавлена новая аннотация для поддержки
интерфейса Trigger3.

Обновленные примеры триггеров Обновлены примеры триггеров для
поддержки интерфейса Trigger3.

Обновления библиотеки среды выполнения В комплект поставки входят последние
библиотеки среды выполнения бот.

A2019-package-sdk-2.1.0

Усовершенствования в A2019.20

Функция Описание

Обновления библиотеки среды выполнения В комплект поставки входят последние
библиотеки среды выполнения бот.

A2019-package-sdk-2.0.9

Усовершенствования в Enterprise A2019.19

Функция Описание

Обновления библиотеки среды выполнения В комплект поставки входят последние
библиотеки среды выполнения бот.

Добавлено правило аннотирования Добавлено правило аннотирования
MultipleRecordPicker.

Добавлены аннотации Добавлены аннотации для этапов работы с
рабочим столом.

A2019-package-sdk-2.0.8

Усовершенствования в Enterprise A2019.18

Функция Описание

Обновления библиотеки среды выполнения В комплект поставки входят последние
библиотеки среды выполнения бот.
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Функция Описание

Добавлен общий сеанс Добавлена поддержка общих сеансов.

Улучшенное создание свойств Теперь свойства могут принимать один
параметр.

Добавлено правило для WindowResize и
WindowBrowser

Добавлено новое правило для WindowResize и
WindowBrowser.

Несущественные зависимости в
build.gradle закомментированы

Несущественные зависимости в
build.gradle теперь закомментированы.
Включите их для компиляции образцов SDK
для пакетов.

A2019-package-sdk-2.0.7

Усовершенствования в Enterprise A2019.17

Функция Описание

Обновления библиотеки среды выполнения В комплект поставки входят последние
библиотеки среды выполнения бот.

В пользовательские пакеты добавлено имя
автора

Добавлена поддержка добавления
имени автора в столбец поставщика
пользовательских пакетов.

Добавлен атрибут File2 Добавлен новый тип атрибута File2.

Добавлено правило «Тип файла» Добавлено новое правило «Тип файла».

A2019-package-sdk-2.0.6

Усовершенствования в Enterprise A2019.16

Функция Описание

Обновления библиотеки среды выполнения В комплект поставки входят последние
библиотеки среды выполнения бот.

Добавлено NoLogging Добавлена поддержка NoLogging.

A2019-package-sdk-2.0.5

Усовершенствования в Enterprise A2019.15

Функция Описание

Обновления библиотеки среды выполнения В комплект поставки входят последние
библиотеки среды выполнения бот.

A2019-package-sdk-2.0.4
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Усовершенствования в Enterprise A2019.14

Функция Описание

Операции рабочего стола Добавлена поддержка операций рабочего
стола.

Образцы для действий в файле загрузки Добавлены дополнительные образцы для
действий в файле загрузки SDK для пакетов.

Обновления библиотеки среды выполнения В комплект поставки входят последние
библиотеки среды выполнения бот.

A2019-package-sdk-2.0.3

Усовершенствования в Enterprise A2019.13

Функция Описание

Валидация времени для региональных
настроек

Добавлена валидация времени компиляции
для файла JSON региональных настроек.

Список записей Добавлена поддержка ENTRYLIST

Обновления библиотеки среды выполнения В комплект поставки входят последние
библиотеки среды выполнения бот.

A2019-package-sdk-2.0.2

Усовершенствования в A2019.12.1

Функция Описание

Образцы триггеров Добавлены образцы триггеров в файле
загрузки SDK для пакетов. Загрузите
последнюю версию SDK для пакетов, чтобы
получить доступ к файлам с образцами.

A2019-package-sdk-2.0.1.zip

Усовершенствования в Enterprise A2019.12

Функция Описание

Библиотеки среды выполнения Добавлены последние версии библиотек
среды выполнения.

Пользовательский триггер В этом выпуске поддерживается создание
пользовательских триггеров.

Образец Мы добавили дополнительные образцы кода.
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Функция Описание

В документацию пакета добавлен образец
кода HierarchyDemo.java. (ID обращения к
облачному сервису: 00469066)

Создайте простое действие с несколькими
вариантами выбора. Пользовательский
интерфейс отличается в зависимости от
выбранных параметров.

A2019-package-sdk-2.0.0.zip

Усовершенствования в A2019.11

Функция Описание

Библиотеки среды выполнения Этот пакет содержит последние версии
библиотек среды выполнения.

A2019-package-sdk-1.0.11.zip

Усовершенствования в Enterprise A2019.10

Функция Описание

Обновлена поддержка аннотаций Добавлена поддержка новых аннотаций
атрибутов.

Улучшенная комплектация SDK В поставку входит java doc в составе
zip-архива SDK для пакетов. Теперь вам
нужно загружать только один zip-файл.

Библиотеки среды выполнения В комплект поставки входят последние
библиотеки среды выполнения бота.

Другие примеры Добавлены новые примеры в zip-архиве.

Типы данных Добавлены новые типы данных.

A2019.10-package-sdk-1.0.0.zip

Note:  Начиная с выпуска A2019.10 все компоненты для SDK для пакетов включаются в один
zip-файл.

Усовершенствования в Enterprise A2019.09

Функция Описание

Библиотеки среды выполнения Бот В комплект поставки входят последние
библиотеки среды выполнения бот для SDK
для пакетов A2019.09.

• Демонстрационный пакет SDK: A2019.09-packageSDK-1.0.0.zip
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• Документация: A2019.09-package-annotations-javadoc.zip

Усовершенствования в Enterprise A2019.08

Функция Описание

Библиотеки среды выполнения Бот В комплект поставки входят последние
библиотеки среды выполнения бот для SDK
для пакетов A2019.08.

Поддержка свойств Расширенная поддержка свойств.

Расширены и улучшены комментарии Добавлены дополнительные комментарии
к образцам команд для облегчения
использования SDK.

Форматирование полей комментариев В поля комментариев добавлены цвет текста
и цвет фона.

• Демонстрационный пакет SDK: A2019.08-packageSDK-1.0.0.zip
• Документация: A2019.08-package-annotqations-javadoc.zip

Усовершенствования в A2019.07

Функция Описание

Библиотеки среды выполнения Бот Библиотеки среды выполнения бот A2019.07
входят в состав SDK для пакетов.

Атрибут CREDENTIAL Мы обеспечиваем поддержку атрибутов
учетных данных, которые требуют ввода с
экранов действий.

Локализованные сообщения об ошибках
и текст пользовательского интерфейса
действий

Позволяет разрабатывать пакеты
с сообщениями об ошибках i18n и
локализованным (l10n) пользовательским
интерфейсом действий с локализованным
текстом.

Комплект для разработки Java 11 Комплект для разработки пакетов A2019.07
поддерживает JDK 11.

• Демонстрационный пакет SDK: A2019.07-Package-Sdk-1.0.0.zip
• Документация: A2019.07-package-annotations-javadoc.zip

Process Discovery Release Notes
Review the new features and improvements in each release.
Use the links to view the release notes updates for each release.
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For information related to features and fixes in previous Process Discovery releases, see the PDFs for these
releases: Process Discovery documentation (release versions).

Обнаружение процессов Version 1.63.0 Release Notes
Review the new fixes available in this release.
Release Date: 21-February-2023
For information related to features and fixes in previous Process Discovery releases, see the PDFs for these
releases: Process Discovery documentation (release versions).

Функции

From the Manage Users page, Process Discovery Admins can create their own login password for the Event
Reporting interface.

Note:  The Event reporting interface is your Kibana account.

Create your event reporting password on page 2303

Исправления

• You can view the step count for each process from the Mining Runs, Process Explorer, Process View,
and Processes pages. For each process, the step count should be the same across all pages. Previously,
when you viewed the step count from the Processes page, the step count was incorrect.

• You can select any Mining IDs in the Filters option, even when the mining run you created generates
no paths. Previously, when you created a mining run and no paths were found (the Status column is
updated to display the path status), you could not search the path using the Mining ID.

• The Observer activity dashboard displays data collected for the observers. Previously, the dashboard
displayed zero bytes in the Data Collected graph and zero events in the Events Collected graph.

• You can configure the Observer activity settings even when the Windows username (username listed
in the Users column) contains a period. Previously, if the username contained a period, and you
configured the Observer settings for that observer, a server error occurred.

Neo Sensor Version 2.4.1
Review the new feature and fixed issues available in this release.
Release Date: 18-November-2022
Feature and Fixed issues
Contact your Customer Success Manager (CSM) or Partner Enablement Manager (PEM) for the latest
version. For information related to features and fixes in the previous Neo Sensor release, see the PDFs for
these releases: Process Discovery documentation (release versions). Neo Sensor Version 2.4.1 includes the
following updates:
Feature
You can now adjust the Neo Senor debug level, and the log will contain more details regarding the
screenshots taken by the application. For example, the Area of Interest screenshot size and actions is
detailed in the log. To adjust the debug level, set the debug value to one of the following in the NeoConfig
json configuration file:
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• Set DEBUG to 1 in the installer.
• Set Debug to 1 in the registry.
• Set debug to 1 in the NeoConfig json configuration file if running in portable mode.

Fixed issues
For Observer Users that have a multi-monitor setup and the ScreenFullCapture setting is disabled, you
can now view the screenshot taken on the correct monitor. Previously, only the Primary monitor was used
in making the comparison between the screenshot taken and the desktop size.
You can now use two different methods to determine where an application’s screen is located. You
can adjust the SCREEN_FETCH_METHOD in the installer, ScreenFetchMethod in the registry, or
screenFetchMethod in the NeoConfig json configuration file if running in portable mode with one of these
values:
• 1 (default value) will use the center of the active window to determine the position.
• 2 will use the active windows reported handle from Microsoft Windows.

CoE Manager Release Notes
Review the CoE Manager feature available in Automation 360 v.26 release.

Introduction

Use CoE Manager - powered by Shibumi to scale your automation programs more quickly and efficiently.
CoE Manager provides visibility into your end-to-end automation lifecycle and accelerates pipeline
generation. It provides a consistent way of assessing automation opportunities which helps in minimizing
the variations and maximizing the ROI.
CoE Manager is available out of the box and requires minimal configuration for first-time use.

Совместимость Automation Anywhere Enterprise

Automation 360: The Control Room can be a Cloud or On-Premises deployment.
CoE Manager on page 2943.

Browser extensions for Automation 360
Создавайте автоматизацию из поддерживаемых браузеров с помощью расширений браузера.
Расширения периодически обновляются для поддержки улучшений и исправлений функций.
Поэтому убедитесь, что у вас установлены последние версии расширений для браузеров Google
Chrome, Microsoft Edge и Mozilla Firefox.
Before you download the latest version of a browser extension, review the information in the following
tables:
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Browser extension for Manifest V3

Имя
расширения

Версия
расширения

Исправления Ссылка на
расширение

Google
Chrome

3.0.8.0 During web automation, the web page maintains its
position when the target object is already visible on
the page. This improves the automation reliability
when there is a fixed pane on the web page and
physical actions (such as mouse click) do not work as
expected.

Google Chrome
extension for
Automation 360

Microsoft Edge
на основе
Chromium

3.0.8.0 During web automation, the web page maintains its
position when the target object is already visible on
the page. This improves the automation reliability
when there is a fixed pane on the web page and
physical actions (such as mouse click) do not work as
expected.

Microsoft Edge
extension for
Automation 360

Browser extensions for Manifest V2

Impact to our customers: Automations that use Google Chrome Manifest V2 based extensions will
stop working sometime after June 2023. The deprecation timelines of Manifest V2 based extensions are
currently under review and subject to change by Google.
• For Google Chrome Manifest V2 extensions timelines, see Manifest V2 support timeline.
• For Microsoft Edge Manifest V2 extensions timelines, see Overview and timelines for migrating to Manifest

V3.

Имя расширения Версия расширения Ссылка на расширение

Google Chrome 1.7.0.0 Automation 360 extension for
Chrome

Microsoft Edge на основе
Chromium

1.7.0.0 Automation 360 extension for
Microsoft Edge

Mozilla Firefox 1.7.0.0 Automation 360 extension for
Mozilla Firefox

Related concepts
Automation 360 — заметки о выпуске on page 65
Review the new capabilities, changes, fixes (resolved issues), security fixes, deprecated features, and
limitations in each release.
Related reference
Требования к браузеру для доступа к Рабочая область RPA on page 872
Доступ к интерфейсу Рабочая область RPA из браузера. After you have installed and enabled
extensions in the browser, perform several tasks through the Рабочая область RPA interface based on
your user role and automation requirements.
Совместимость Bot Agent on page 1032
Перед установкой Bot Agent убедитесь, что он совместим с аппаратным и программным
обеспечением в вашем окружении.
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https://chrome.google.com/webstore/detail/automation-360/kammdlphdfejlopponbapgpbgakimokm
https://chrome.google.com/webstore/detail/automation-360/kammdlphdfejlopponbapgpbgakimokm
https://microsoftedge.microsoft.com/addons/detail/automation-360/dbmodiepejcigljbmeebedkmegndokbk
https://microsoftedge.microsoft.com/addons/detail/automation-360/dbmodiepejcigljbmeebedkmegndokbk
https://addons.mozilla.org/en-US/firefox/addon/automation-anywhere-a2019
https://addons.mozilla.org/en-US/firefox/addon/automation-anywhere-a2019
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Browser extensions for web applications
You can create automations using the Google Chrome and Microsoft Edge browser extensions for web
applications running on Google Chrome and Microsoft Edge, which enables you to automate with enhanced
security and performance.

Features using browser extensions for web applications

The following Automation 360 features use the browser extensions for web applications running on Google
Chrome or Microsoft Edge browsers:
• Automation of web applications through Universal Recorder or Браузер пакет
• User interface-based triggers
• Bot Agent device registration with the Control Room
• Пакеты that use window titles, for example, Распознавание текста (OCR) and Mouse > Click.

Use browser extensions to automate web applications

To automate web applications, the browser extensions capture the properties of the targeted UI elements,
application window title, and URL that enables you to create or update the actions that are specific to the
Средство записи in the боты. Newly created or updated боты are then uploaded from the browser of the
Bot Creator to the Control Room. All боты are stored in the Control Room along with the properties of the
UI element. When a бот is running, browser extensions are used to automate actions on the targeted UI
elements of the web-based business applications.
When a Bot Creator or a Bot Runner user connects to the Control Room for the first time over Google
Chrome or Microsoft Edge browsers, the browser extensions enable you to register your device by
automatically sharing the device name and windows username, with the Control Room.

Note:  Firefox browser extension supports object-based automation of web applications running in Firefox
browser. Registering your device over Firefox browser is not yet supported.

Previous versions of browser extensions
Review the version history of browser extensions from past releases.

Version 3.0.7.0

Имя расширения Исправления

Google Chrome • Timeout issues no longer occur on websites that
previously had high loading time because now the
JavaScript with debugger is performed successfully
on any page that has a CSP policy.

• Fix provided for document.evaluate if
the document.querySelector is blocked.
Previously, user interaction functions on some
websites were not available because the
document.querySelector was blocked.
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Имя расширения Исправления

Microsoft Edge на основе Chromium • Timeout issues no longer occur on websites that
previously had high loading time because now the
JavaScript with debugger is performed successfully
on any page that has a CSP policy.

• Fix provided for document.evaluate if
the document.querySelector is blocked.
Previously, user interaction functions on some
websites were not available because the
document.querySelector was blocked.

Version 3.0.6.0

Имя расширения Исправления

Google Chrome • Enhancement to add case sensitivity option for
static window titles in Google Chrome and Microsoft
Edge

• Fixes to capture objects and perform selected
actions in a migrated бот using Средство записи in
Google Chrome and Microsoft Edge

• Fixes to run JavaScript after executing Средство
записи actions in a бот in Google Chrome and
Microsoft Edge

• Fixes to capture pop-up windows with Automation
360 plug-in enabled in Google Chrome and
Microsoft Edge.

Microsoft Edge на основе Chromium • In the Средство записи package, you can now use
the Click or Left click action on the JavaScript
alert, prompt, and confirmation pop-up windows to
automate web pages on Microsoft Edge browser.

• In the package, you can now use the Click for the
Link and Form tag controls that have inline scripting
with using Manifest V3 extensions.

Version 3.0.5.0

Имя расширения Исправления

Google Chrome

Microsoft Edge на основе Chromium
• Исправления для запуска JavaScript внутри

iFrame в Google Chrome
• Усовершенствование для исключения

загрузки страниц по умолчанию в Google
Chrome и Microsoft Edge
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Матрица сравнения функций Automation 360
Используйте матрицу сравнения функций для сравнения функций Automation 360 с функциями в
Automation Anywhere Enterprise 11.3.x и версиях Enterprise 10.
Для получения подробной информации о новейших функциях и усовершенствованиях см. заметки о
выпуске Automation 360.

Основные компоненты

Automation 360 Enterprise 11.3.x Enterprise 10.x

Целевой пользователь Непрофессиональный
разработчик
Специалист/разработчик
RPA
IT

Разработчик RPA
IT

Разработчик RPA
IT

Модель доставки On-Premises
Cloud
С поддержкой
облака

On-Premises On-Premises
BotFarm (для Bot
Runner)

Операционная
система

Microsoft Windows
Linux (Linux
CentOS 7.7, 7.9 и
8.3) и (Red Hat
Enterprise Linux 7.7,
7.9 и 8.3)

(Операционная
система не
применяется для
Cloud)

Microsoft Windows Microsoft Windows

Поддержка Microsoft
Active Directory

Доступно Доступно Доступно

SAML 2.0 Available Available Недоступно

Поддержка
прокси-сервера с
аутентификацией

Доступно Недоступно Недоступно

Локализованный
пользовательский
интерфейс (UI)

15 языков 3 языка Недоступно

Поддержка Bot Insight Доступно Доступно Доступно (базовый)

Поддержка IQ Bot Доступно Доступно Доступно (базовый)

Поддержка
интерактивных форм
(сопровождаемая
автоматизация)

Доступно Недоступно Недоступно
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Automation 360 Enterprise 11.3.x Enterprise 10.x

Платформа Bot
Creator

Локальный «тонкий»
клиент

«Толстый» клиент «Толстый» клиент

Платформа Bot Runner Развернуто в
Интернете

«Толстый» клиент «Толстый» клиент

боты с
сопровождением

Доступно Доступно Недоступно

боты без
сопровождения

Доступно Доступно Доступно

Обновление для
использования новых
actions или команд

Обновление для
Cloud не требуется
Для развернутых
On-Premises и в
облаке требуется
обновление

Требуется обновление Требуется обновление

Автоматизированная
постановка задания в
очередь

Доступно Доступно Недоступно

Централизованное
лицензирование

Доступно Доступно Доступно

Высокая доступность Available Available Available

Балансировщик
нагрузки

Доступно Доступно Доступно

Аварийное
восстановление

Available Available Available

Поддержка
нескольких доменов

Доступно Доступно Доступно

Технология хостинга Java • Java (Control Room)
• Microsoft .NET

Framework
(Enterprise Client)

Microsoft IIS

Доступ на основе
функций

Доступно Доступно Доступно

Power BI Доступно Недоступно Недоступно

Табличный коннектор
для Bot Insight

Доступно Недоступно Недоступно

Управление версиями Доступно при
использовании
интеграции с Git
(Subversion устарел)

Доступно при
использовании
интеграции с
Subversion

Доступно при
использовании
интеграции с
Subversion

Интеграция с SysLog Доступно Доступно Недоступно
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Возможности сервера Control Room

Функция Automation 360 Enterprise 11.3.x Enterprise 10.x

Управление
версиями — установка
рабочей версии

Доступно Доступно Доступно

Управление
версиями —
сравнение двух
версий бот

Доступно Доступно Доступно

Управление
версиями — проверка
истории версий

Доступно Доступно Доступно

Управление
версиями — откат к
предыдущей версии

Доступно Доступно Доступно

Многофакторная
или двухфакторная
аутентификация

Доступно (при
использовании SSO)

Доступно
(собственная и при
использовании SSO)

Недоступно

Текст баннера при
входе в Control Room

Доступно Доступно Недоступно

Установка Control
Room в Oracle
Database

Available Available Недоступно

Журнал аудита Available Available Available

Открытие
веб-страницы
на новой или
существующей
вкладке Internet
Explorer

Доступно Доступно Доступно

Открытие
веб-страницы
на новой или
существующей
вкладке Google
Chrome

Доступно Недоступно Недоступно

Настройка для нового
сеанса входа в Control
Room

Устарело Доступно Недоступно

Настройка срока
действия API-ключей

Доступно Недоступно Недоступно

Настройка проверки
электронной почты
при создании
пользователя

Доступно Доступно Недоступно
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Функция Automation 360 Enterprise 11.3.x Enterprise 10.x

Включение ведения
журнала отладки

Доступно Доступно Недоступно

Разработка Бот

Функция Automation 360 Enterprise 11.3.x Enterprise 10.x

Обучение в процессе
работы

Доступно Недоступно Недоступно

Представление потока
Bot Creator

Доступно Недоступно Недоступно

Двойное
представление Bot
Creator

Доступно Недоступно Недоступно

Представление кода
Bot Creator

Доступно Available Available

Представление
визуализации Bot
Creator

Недоступно Available Available

Поиск действий Доступно Недоступно Недоступно

Поиск текста Доступно Доступно Доступно

Расширенные
выражения

Доступно Ограниченная
доступность

Ограниченная
доступность

Регулярное
выражение

Доступно Доступно Доступно

Удаленное
тестирование
устройств

Доступно
(Разработка на
одном устройстве
и тестирование на
другом устройстве)

Недоступно Недоступно

Локализованные
действия

Доступно Недоступно Недоступно

Совместная
разработка

Доступно Недоступно Недоступно

Интеграция с Bot
Store

Доступно Доступно (Version
11.3.3 и более
поздние)

Недоступно

Триггеры эл. почты Доступно Доступно Доступно

Триггеры файлов и
папок

Доступно Доступно Доступно

Триггеры горячих
клавиш

Доступно Доступно Доступно
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Функция Automation 360 Enterprise 11.3.x Enterprise 10.x

Триггеры
пользовательского
интерфейса

Доступно Недоступно Недоступно

Триггеры
производительности

Недоступно Available Available

Триггеры процессов Available Available Available

Триггеры служб Available Available Available

Триггеры окон Available Available Available

MetaBot Логика Доступно при
использовании
TaskBot

Доступно Доступно

DLL MetaBot Доступно при
использовании DLL:
Действие «Выполнить
функцию»

Доступно Доступно

Повторная
калибровка экрана
MetaBot

Недоступно Available Available

Bot Lifecycle
Management - Import
and export боты

Available Available Недоступно

Глобальные значения Available Недоступно Недоступно

Клонирование Бот Доступно Недоступно Недоступно

Развертывание API Доступно Доступно Недоступно

Сеансы Bot Runner в
Control Room

Available Available Available

Упаковка
зависимостей Бот

Доступно Доступно Доступно

Пропустить
юридическое
уведомление

Available Available Available

Редактирование
имени переменной

Доступно Доступно Доступно

Копирование команд
из одного бот в
другой

Доступно
Опция «Триггеры»
недоступна.

Доступно Доступно

Сохранение бот в
формате XML/TXT

Недоступно Available Available

Отключение мыши и
клавиатуры для бот

Недоступно Available Available

Запуск бот в скрытом
режиме

Недоступно Available Available
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Функция Automation 360 Enterprise 11.3.x Enterprise 10.x

Отображение или
скрытие ошибок во
время выполнения
бот.

Недоступно (устарело
для Automation 360)

Доступно Доступно

Копирование
переменных из одного
бот в другой

Доступно Доступно Доступно

Поддержка
междоменных iFrame
в браузерах.

Доступно
Поддерживается
в Google Chrome и
Microsoft Edge.

Доступно
Поддерживается в
Internet Explorer.

Доступно
Поддерживается в
Internet Explorer.

Расширяемость и повторное использование кода Бот

Функция Automation 360 Enterprise 11.3.x Enterprise 10.x

Пользовательские
actions в палитре

Доступно (сборка
с использованием
комплекта для
разработки пакетов)

Недоступно Недоступно

Встроенные сценарии Доступно в Python,
VBScript и JavaScript

Доступно в VBScript Недоступно

Повторное
использование кода

Доступно
для TaskBots,
пользовательских
actions и библиотек
DLL

Ограниченная
доступность для
MetaBots и библиотек
DLL

Ограниченная
доступность для
MetaBots и библиотек
DLL

Быстрая привязка для
переменных

Доступно Доступно Доступно

Тайм-аут Бот Доступно Доступно Доступно

Приоритет Бот Доступно Доступно Доступно

Совместное
использование сеанса
DLL

Доступно Недоступно Недоступно

Запуск бот с
повторным
использованием
конфигурации
прошлого запуска со
страницы История

Доступно Доступно Недоступно
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Возможности интеграции

Функция Automation 360 Enterprise 11.3.x Enterprise 10.x

Вызовы с
использованием
встроенных сценариев

Доступно для Python,
VBScript и JavaScript

Недоступно Недоступно

API-интерфейсы
Control Room

Доступно Доступно Недоступно

Веб-служба REST Available Available Available

Веб-служба SOAP Available Available Available

Возможности использования устройств

Функция Automation 360 Enterprise 11.3.x Enterprise 10.x

Управление рабочей
нагрузкой

Available Available Недоступно

Группы устройств Available for scheduling
and workload
management

Available in workload
management only

Недоступно

Группа «Запустить как
пользователи» для
автоматизаций

Доступно
Настройка нескольких
выполнений от имени
пользователя для
групп устройств с
целью обеспечения
эффективного
использования
лицензий и устройств

Недоступно Недоступно

Фоновая обработка Доступно Недоступно Недоступно

Непостоянная
инфраструктура
виртуальных рабочих
столов (VDI)

Доступно Доступно Доступно

Возможности средства записи

Функция Automation 360 Enterprise 11.3.x Enterprise 10.x

AISense Recorder Available Available Недоступно
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Функция Automation 360 Enterprise 11.3.x Enterprise 10.x

Unified Recorder Доступно (включает
поддержку Microsoft
Edge Chromium)
• Извлечение

данных на
основе шаблонов
недоступно

• Предыдущие
версии Microsoft
Edge и Flash/Flex
устарели

Недоступно
(возможности записи
при использовании
Средство веб-записи,
Smart Recorder и
Standard или Screen
Recorder)

Недоступно
(возможности записи
при использовании
Средство веб-записи,
Smart Recorder и
Standard или Screen
Recorder)

Средство записи для
Интернета/Windows

Доступно Доступно Доступно

Средство записи для
SAP

Доступно Доступно Недоступно

Средство записи для
Citrix

Доступно Доступно Недоступно

Средство записи для
Oracle

Доступно Доступно Недоступно

Безопасная запись Available Available Available

Microsoft Silverlight —
5 настольных и
веб-приложений

Доступно
(Элементы
управления сторонних
производителей
недоступны)

Доступно Доступно

Выбор технологии
записи в средстве
записи

Available Available Available

Бот пакеты

Функция Automation 360
пакеты

Команды
Enterprise 11.3.x

Команды
Enterprise 10.x

AARI on the web Available Недоступно Недоступно

Active Directory Available Available Available

Analyze Available Недоступно Недоступно

Приложение Available Available Available

Интеграция
приложений

Available Available Available

Логический Available Недоступно Недоступно

Миграция Бот Available Недоступно Недоступно
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Функция Automation 360
пакеты

Команды
Enterprise 11.3.x

Команды
Enterprise 10.x

Браузер Available
Указанные ниже
действия доступны
только для браузера
Google Chrome.
• Закрыть
• Получить исходный

код
• Назад
• Выполнить

JavaScript

Доступно (при
использовании
Средство веб-записи)
Команды Средство
веб-записи команды
только для браузера
Internet Explorer.

Доступно (при
использовании
Средство веб-записи)
Команды Средство
веб-записи команды
только для браузера
Internet Explorer.

Citrix Automation Недоступно
(Устарело и заменено
средством Unified
Recorder)

Доступно Доступно

Буфер обмена Доступно Доступно Доступно

Комментарий Доступно Доступно Доступно

Credential Vault Доступно Доступно Доступно

CSV/TXT Доступно Доступно Доступно

Таблица данных Доступно Доступно при
использовании
переменной типа
«Массив»

Доступно при
использовании
переменной типа
«Массив»

База данных Available Available Available

Дата/время Available Недоступно Недоступно

Задержка Available Available Available

Словарь Available Недоступно Недоступно

DLL Available Ограниченная
доступность при
использовании
MetaBots

Ограниченная
доступность при
использовании
MetaBots
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Функция Automation 360
пакеты

Команды
Enterprise 11.3.x

Команды
Enterprise 10.x

Эл. почта Доступно (SMTP, EWS
и Outlook)
Указанные ниже
опции недоступны.
• Отправка

сообщения эл.
почты с шаблоном

• Добавление
изображения в
сообщение эл.
почты

Доступно (SMTP, EWS) Доступно (SMTP)

Обработчик ошибок Доступно
(расширенный —
«Попробовать»,
«Выявить»,
«Окончательно»,
«Вызвать»)

Доступно (базовый) Доступно (базовый)

Расширенный Excel Available Ограниченная
доступность

Ограниченная
доступность

Базовый Excel (без
Excel)

Доступно Недоступно Недоступно

Операции Файл Доступно Доступно Доступно

Операции Папка Доступно Доступно Доступно

FTP / SFTP Доступно Доступно Доступно

Если Доступно Доступно Доступно

Распознавание
изображений

Доступно Доступно Доступно

Операции с
интерактивные
формами

Доступно Недоступно Недоступно

Internet Connection Недоступно (устарело
для Automation 360)

Доступно Доступно

IQ Bot Доступно Доступно Доступно

Препроцессор IQ Bot Доступно Недоступно Недоступно

IQ Bot (локальное
устройство)

Устарело Недоступно Недоступно

JavaScript Available Доступно при
использовании
действия «Запустить
сценарий»

Доступно при
использовании
действия «Запустить
сценарий»
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Функция Automation 360
пакеты

Команды
Enterprise 11.3.x

Команды
Enterprise 10.x

Автоматизация
предыдущих версий
(для перенесенных
боты)

Доступно (для
миграции)

Недоступно Не применимо

Операции Список Доступно Недоступно Недоступно

Записать в файл Available Available Available

Цикл Available Available Available

Message Box Available Available Available

Экраны MetaBot Недоступно
(Заменено средством
Universal Recorder)

Доступно Доступно

Мышь Доступно Доступно Доступно

Число Доступно Недоступно Недоступно

Распознавание текста
(OCR)

Available Available Available

Календарь Office 365 Available Недоступно Недоступно

Office 365 Excel Available Доступно (настольный
компьютер)

Недоступно

Office 365 OneDrive Available Недоступно Недоступно

One Drive Доступно Недоступно Недоступно

PDF Available Available Available

PGP Available Available Available

Воспроизвести звук Available Available Available

Принтер Available Available Available

Запрос Available Available Available

Python Script
(встроенный)

Доступно Недоступно Недоступно

Запись Available Недоступно Недоступно

Средство записи Available Available Available

Веб-служба REST Available Available Available

Поддержка SAP Доступно
(собственная)

Ограниченная
доступность при
использовании
MetaBots

Ограниченная
доступность при
использовании
MetaBots
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Функция Automation 360
пакеты

Команды
Enterprise 11.3.x

Команды
Enterprise 10.x

SAP BAPI Available
SAP BAPI,
разработанный
на заказ, не
поддерживается.

Доступно Доступно

Экран Доступно Доступно Доступно

Службы Доступно Доступно Доступно

Имитация нажатия
клавиш

Доступно Доступно Доступно

SNMP Доступно Доступно Доступно

Веб-служба SOAP Доступно Доступно Доступно

Шаг Доступно Недоступно Недоступно

Строка Available Available Available

Система Available Available Available

TaskBot Available Available Available

Эмулятор терминала Available Available Available

Текстовый файл Available Недоступно Недоступно

Триггерный Цикл Доступно Недоступно Недоступно

VBScript (встроенный) Доступно Доступно как Run
Script

Недоступно

Ожидать Available Available Available

Окно Available Available Available

Рабочая нагрузка Available Available Недоступно

XML Available Available Available

Поддержка переменных

Important:  При миграции с версий Enterprise 11.3.x или Enterprise 10 на Automation 360 некоторые
переменные сопоставляются напрямую, а некоторые содержат другую конфигурацию.

Переменная Automation 360 Enterprise 11.3.x Enterprise 10.x

Переменные приложения

Analytics Available Available Недоступно

ArrayRows Доступно при
использовании
рекурсивных
выражений

Доступно Доступно
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Переменная Automation 360 Enterprise 11.3.x Enterprise 10.x

ArrayColumns Доступно при
использовании
рекурсивных
выражений

Доступно Доступно

Clipboard Доступно Доступно Доступно

Credential Доступно Доступно Недоступно

Dictionary Доступно при
использовании пакет
Словарь

Доступно Недоступно

Enter (String variable) Available Available Available

Prompt Assignment
(user-defined)

Available Available Available

Read from Excel/CSV Доступно при
использовании пакет
Расширенный Excel

Доступно при
использовании
определяемой
пользователем
переменной типа
«Массив»

Доступно при
использовании
определяемой
пользователем
переменной типа
«Массив»

Read from database Доступно при
использовании пакет
База данных

Доступно при
использовании
определяемой
пользователем
переменной типа
«Массив»

Доступно при
использовании
определяемой
пользователем
переменной типа
«Массив»

Read from text file Доступно при
использовании пакет
CSV/TXT

Доступно при
использовании
определяемых
пользователем
переменных типа
«Массив», «Список» и
«Значение»

Доступно при
использовании
определяемых
пользователем
переменных типа
«Массив», «Список» и
«Значение»

Separator (String
variable)

Available Available Available

Tab (String variable) Available Available Available

Work Item Available Available Недоступно

Системные переменные

AAApplicationPath Доступно при
использовании
глобальных значений

Доступно Доступно

AADefaultDateFormat Доступно при
использовании
глобальных значений

Недоступно Недоступно

AAInstallationPath Available Available Available

AATaskExecutor Available Available Недоступно
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Переменная Automation 360 Enterprise 11.3.x Enterprise 10.x

AATaskName Available Available Недоступно

AAControlRoom Available Available Недоступно

Counter Доступно при
использовании пакеты
Число и Цикл

Доступно Доступно

CPUUsage Доступно Доступно Доступно

CurrentDirectory Доступно при
использовании пакет
Цикл

Доступно Доступно

DatasetColumn Доступно при
использовании пакет
Цикл

Доступно Доступно

Date Доступно Доступно Доступно

Day Доступно Доступно Доступно

Email (includes
EmailFrom,
EmailMessages,
EmailReceivedDate,
EmailReceivedTime,
EmailSubject, EmailTo,
EmailSentDate, and
EmailSentTime)

Доступно при
использовании пакеты
Эл. почта, Словарь и
Цикл

Доступно Доступно

ErrorLineNumber Доступно при
использовании пакет
Обработчик ошибок

Доступно Доступно

ErrorDescription Доступно при
использовании пакет
Обработчик ошибок

Доступно Доступно

Excel (includes
ExcelColumn, ExcelCell,
ExcelCellColumn, and
ExcelCellRow)

Доступно при
использовании пакет
Расширенный Excel

Доступно Доступно

Extension Доступно при
использовании
действия GetProperty
из пакет PDF

Доступно Доступно

FileDataColumn Доступно как
переменная
типа записи при
использовании пакет
Цикл

Доступно Доступно

FileName Доступно при
использовании пакета
Файл

Доступно Доступно
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Переменная Automation 360 Enterprise 11.3.x Enterprise 10.x

FolderName Доступно при
использовании пакета
Папка

Доступно Доступно

Hour Доступно Доступно Доступно

Machine Доступно Доступно Доступно

Millisecond Доступно Недоступно Недоступно

Minute Available Available Available

Month Available Available Available

OSName Available Available Available

PDF (includes
PDFFileName, PDFTitle,
PDFAuthor, and
PDFSubject)

Доступно при
использовании
действия GetProperty
из пакет PDF

Доступно Доступно

RAMUsage Доступно Доступно Доступно

Second Доступно Доступно Доступно

TableColumn Недоступно Available Available

TotalRAM Available Available Available

Trigger Доступно при
использовании
Interface trigger

Доступно Доступно

Year Доступно Доступно Доступно

XMLDataNode Доступна как
переменная
строкового типа при
использовании пакет
Цикл

Доступно Available

Related concepts
Automation 360 — заметки о выпуске on page 65
Review the new capabilities, changes, fixes (resolved issues), security fixes, deprecated features, and
limitations in each release.
SDK для пакетов on page 2379
SDK для пакетов позволяет создавать и загружать пакеты действий в Control Room.
Related reference
Операционная система, окружение и платформа, поддерживаемые для Control Room on page 855
Automation 360 можно разместить в AWS, Microsoft Azure, Google Cloud Platform, IBM и любой
общедоступной, частной или гибридной облачной службе, которая отвечает требованиям к
аппаратному и программному обеспечению Control Room и Bot Agent.
ЧАСТО ЗАДАВАЕМЫЕ ВОПРОСЫ ПО Automation 360 on page 52
Подробные сведения и вопросы по новейшей платформе Automation Anywhere, Automation 360, см. в
настоящем разделе «Часто задаваемые вопросы».
Сопоставление переменных для миграции on page 1293
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При миграции некоторые переменные из предыдущих версий продукта напрямую сопоставляются
с Automation 360, в то время как другие переменные ведут себя иначе или имеют измененную
конфигурацию.
Глобальные значения on page 2058
Global values enable users to reuse identical values between боты instead of creating new variables for
each бот. A user with the AAE_admin role configures a global value with a default value and can enable
non-admin users to overwrite the value to use in their боты.
Recursive expressions on page 2049
Use a recursive expression to insert a variable in the place of an index or key of a dictionary, list, record, or
table variable.

Матрица сравнения функций Automation 360 IQ Bot
Compare the key features of Automation 360 IQ Bot deployment models and review the feature parity with
the latest IQ Bot 11.3.x release.

Automation 360 IQ BotIQ Bot basic features

On-Premises Cloud Community
Edition

IQ
Bot 11.3.x

Prebuilt domains Да Да Да
Supported
domains include:
• Invoices
• Purchase

orders
• Bank

statements
• Кредитовое

авизо
• Utility bills

Да

User confidence threshold
in Валидатор

Да Нет Нет Да

Learning instance creation/
editing/renaming

Да Да Да Да

Document image
preprocessing

Да Да Да Да

Document image
classification

Да Да Да Да

Document image OCR Да Да Да Да

Google Vision OCR Да Да Да Да

Tegaki API OCR engine Да Нет Нет Да

MICR (magnetic ink
character recognition)
extraction

Да Да Да Да

PDFBox Toggle Да Да Да Да
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Automation 360 IQ BotIQ Bot basic features

On-Premises Cloud Community
Edition

IQ
Bot 11.3.x

Caching (enhanced
performance)

Да Да Да Да

Бот limiting Да Да Нет Да

Бот creation/editing/
deletion

Да Да Да Да

Designer/Preview/Test Да Да Да Да

Production toggle Да Да Да Да

Валидатор Да Да Да Да

CSV output files Да Да Да Да

Learning instance import/
export

Да Да Нет Да

Default validations for a
group

Да Да Нет Да

Adding groups manually Да Да Нет Нет

CyberArk support Да Нет Нет Нет

CyberArk support with key
rotation

Да Нет Нет Нет

Automation 360 IQ BotDomain/training features

On-Premises Cloud Community
Edition

IQ Bot 11.3.x

Web-based UI Да Да Да Да

Domain import/export Да Да Нет Да

Hover over text segment to
view OCR

Да Да Да Да

Resize mapped box in
Designer

Да Да Да Да

Delete mapped box in
Designer

Да Да Да Да

Populate text in End of
table/section indicator

Да Да Да Да

Single click to extract text in
the Валидатор

Да Да Да Да

Document group description Да Да Да Да

See extraction results
action displays list of all
training documents in an
alphanumeric sequence

Да Да Да Да
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Automation 360 IQ BotDomain/training features

On-Premises Cloud Community
Edition

IQ Bot 11.3.x

InstallShield patch installer
with simplified upgrade/
downgrade for IQ Bot

Да Нет Нет Да

OCR Pre-processing Settings
configuration

Да Нет Нет Нет

Automation 360 IQ BotExtraction/validation
features

On-Premises Cloud Community
Edition

IQ Bot 11.3.x

Original IQ Bot text
segmentation/document
classifier from IQ Bot Version
5.3.0/6.0

Да Нет Нет Да

New IQ Bot text
segmentation/ document
classifier from IQ Bot Version
5.3.1/6.5

Да Да Да Да

Option to select classifier
version of existing learning
instances during IQ Bot
upgrade:
• Version 1 (IQ Bot 5.3.0 or

before 6.0)
• Version 2 (IQ Bot 5.3.1/

Version 6.5 Beta

Да Нет Нет Да

Enhanced compatibility with
ABBYY FineReader Engine
12.2 Plugin

Да Да Да Да

Automated installation of
ABBYY FineReader Engine
12.2 Plugin

Да Да Да Да

Validator auto-correction Да Да Да Да

Check box extraction Да Да Да Да

Check box auto-detection Да Да Да Да

Advanced extraction:
Repeated tables/sections;
linking tables/sections; map
some header-less columns

Да Да Да Да

Alternative to stop extraction
at End of table/section
indicator

Да Да Да Да
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Automation 360 IQ BotExtraction/validation
features

On-Premises Cloud Community
Edition

IQ Bot 11.3.x

Select text segments that
enclose or are enclosed by
other text segments

Да Да Да Да

Option to select default
training document

Да Да Да Да

Formula validation Да Да Да Да

List validation in UI Да Да Да Да

List validation through
external file

Нет Нет Нет Нет

File/folder search validator Да Да Да Да

Microsoft Azure Computer
Vision API (OCR)

Да Да Да Да

Add user logic in the Designer Да Да Да Да

View and test all documents
in the Designer > See
extraction results

Да Да Да Да

IQ Bot extensions Да Нет Нет Да

Import standard form domains Да Да Нет Да

(Beta) Enabled data capture
and OCR using Google Vision
API for Asian languages

Да Да Да Да

Magnetic ink character
recognition (MICR) extraction

Да Да Да Да

Option to turn off PDFBox as
OCR engine

Да Да Да Да

Using variables in IQ Bot
пакет

Да Да Да Нет

Extraction results opening in a
new browser tab

Да Да Да Нет

Стандартные формы IQ Bot Да Да Нет Нет

Automation 360 IQ BotEnterprise features

On-Premises Cloud Community
Edition

IQ Bot 11.3.x

Access IQ Bot without device
license (without Bot Creator or
Bot Runner license)

Да Да Да Да

Access IQ Bot as Валидатор
users without Bot Creator or
Bot Runner license

Да Да Да Да
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Automation 360 IQ BotEnterprise features

On-Premises Cloud Community
Edition

IQ Bot 11.3.x

Database encryption Да Да Да Да

Roles-based access (RBAC) for
new learning instances

Да Да Нет Да

Журналы аудита Да Да Нет Да

Аутентификация Windows Да Да Нет Да

Azure PaaS Database Service Да Нет Нет Да

Counter for number of
uploaded pages in production

Да Да Нет Да

API access Да Да Да Да

Access IQ Bot without
sysadmin role that includes
support for Amazon Relational
Database Service (RDS) out of
the box

Да Нет Нет Да

Migrate learning instances as
other learning instances are
being edited

Да Да Нет Да

Migration Utility UI Да Да Нет Да

Интернационализация Да Да Да Да

UI Localization:
• Упрощенный китайский
• Традиционный китайский
• Французский
• Немецкий
• Японский
• Корейский
• Испанский
• Итальянский
• Португальский

Да Да Да Да

Automation 360 IQ BotAutomation 360 packages

On-Premises Cloud Community
Edition

IQ Bot Classifier пакет Да Да Нет

IQ Bot [Local Device] пакет Да Да Да

IQ Bot Pre-processor пакет Да Да Да

IQ Bot Extractionпакет Да Да Да
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Related reference
Comparing Automation 360 and Enterprise 11 APIs on page 3007
Compare Automation 360 and Enterprise 11 APIs to understand the contract changes when you migrate
from Enterprise 11 to Automation 360.
Related information
IQ Bot 11.x feature comparison matrix

Automation 360 IQ Bot version compatibility
Review the version compatibility information before you upgrade from an earlier version of Automation 360
IQ Bot to the latest Automation 360 IQ Bot version, or from earlier versions of IQ Bot to Automation 360
IQ Bot.

Compatibility with Automation 360 Control Room

Automation 360 IQ Bot On-Premises version compatibility with Automation 360 Control Room:

Important:  The following table lists the latest build of each Control Room release that is compatible with
the IQ Bot build. Note that, IQ Bot is compatible with all Automation 360 builds in a release. For example,
Automation 360 v.21, IQ Bot build 9642 is compatible with Control Room build 9664 and builds released
after that such as 9595, and 9642 for the same release version. We recommend that you update to the
latest Control Room build for the latest fixes.

IQ Bot On-Premises Control Room

Сборка 16685 Сборка 16685 (Automation 360 v.27)

Сборка 15450 Сборка 15459 (Automation 360 v.26)

Сборка 15112 Сборка 15112 (Automation 360 v.25)

Сборка 13343 Build 13343 (Automation 360 v.24R2)

Сборка 12350 Сборка 12350 (Automation 360 v.24)

Сборка 11513 Сборка 11513 (Automation 360 v.23)

Сборка 10520 Сборка 10526 (Automation 360 v.22)

Сборка 9642 Сборка 9664 (Automation 360 v.21)

Сборка 8815 Сборка 8815 (A2019.20)

Сборка 8098 Сборка 8147 (A2019.19)

Сборка 7554 Сборка 7560 (A2019.18)

Сборка 7082 Сборка 7103 (A2019.17)

Сборка 6443 Сборка 6463 (A2019.16)

Сборка 5931 Сборка 5933 (A2019.15)

Сборка 5322 Сборка 5322 (A2019.14)

Сборка 4695 Сборка 4705 (A2019.13)

Сборка 4088 Сборка 4105 (A2019.12)

Сборка 3337 Сборка 3337 (A2019.11)
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IQ Bot On-Premises Control Room

Сборка 2545 Сборка 2545 (A2019.10)

Сборка 2079 Сборка 2079

Сборка 1610 Сборка 1610

Сборка 1089 Сборка 1089

Сборка 550 Сборка 550

Automation 360 IQ Bot Cloud version compatibility with Automation 360 Control Room:

IQ Bot Cloud Control Room

Сборка 16685 Сборка 16701 (Automation 360 v.27)

Сборка 15436 Сборка 15459 (Automation 360 v.26)

Сборка 14288 Build 14298 (Automation 360 v.25)

Сборка 12342 Build 12342 (Automation 360 v.24)

Migration compatibility with earlier IQ Bot versions

Review the following version compatibility table to understand the available upgrade options for
Automation 360 IQ Bot:

Версия IQ Bot Automation 360 IQ Bot (On-Premises)

Version 11.3.5.x Да

Version 11.3.4.x Да

To migrate to Automation 360 IQ Bot On-Premises from a version earlier than 11.3.4.x, first upgrade to IQ
Bot Version 11.3.4.x or later.

Миграция в Automation 360 IQ Bot on page 1354
Importing learning instances between different IQ Bot versions is not supported. If you want to retain the
associated data for a learning instance, ensure you update or migrate to the correct IQ Bot version before
importing the corresponding learning instance. For example, if you export a learning instance in IQ Bot On-
Premises (Build 8815), you can only import it within an equivalent IQ Bot On-Premises or Cloud build.
Migrate learning instances on page 1362

Automation 360 software lifecycle policy
Automation Anywhere software lifecycle policy aims to make innovations and enhancements available to
you quickly. Through this policy, we provide you predictability, quality, and importantly nondisruptive access
to the latest innovations and enhancements so that you can control when and how you want to adopt
these enhancements.

Note:  The policies mentioned on this page apply to both Automation 360 Cloud and On-Premises
deployments unless where the differences are called out explicitly.
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Обзор

The software lifecycle policy helps you with change management while providing you the latest software
updates with enhancements in the Control Room, Bot Agent, and пакеты.
Our policy aims to provide faster access to features, bug fixes, and other enhancements for a better
customer experience:
• Predictability: With frequent, regular deployment cycles, you can get access to new and enhanced

пакеты sooner than before with predictable release cadence.
• Deploy new features: With control over introducing changes to your боты, you can test new features

and deploy them at your own pace.
• Quality: With automated deployments from Automation 360 Cloud, you can use new пакеты that

include critical bug and security fixes.
• Nondisruptive access: You can update packages without disrupting your existing configurations.
• Backward compatibility: You now have the option to safely update боты while still having the option

to change back to a previous version of a пакет.

The following image shows the advantages of this lifecycle policy:
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Обновления Bot Agent

When a new version of Bot Agent is available, by default, the Bot Agent is deployed automatically
across a customer's pool of devices without impacting existing бот functionality. However, Control Room
administrators can disable this default update capability and choose to update the Bot Agent manually. In
case of manual updates and in the event of a mandatory update, users will be notified that the Bot Agent
must be updated and all бот execution on these devices will stop until the Bot Agent is updated.
For larger deployments where device pools are deployed using standard device Amazon Machine Images
(AMI) on separate schedules, these updates will require coordination, change management processes, and
approvals in the customer environment. Therefore, Automation 360 will support backward-compatible Bot
Agent for a release every 6 months.
Starting with Automation 360 v.24 release, 4 Bot Agent updates will be released each year with 2
optional and 2 updates that might be declared mandatory. You can skip the optional update and update
to the next mandatory Bot Agent update.
Our Q2 and Q4 releases will have optional Bot Agent updates and you can choose to skip the Bot Agent
update. However, the Q1 and Q3 updates might have mandatory Bot Agent updates. We will notify
customers 3 months in advance if a mandatory Bot Agent update is required with a Control Room release.

Обновления Пакет

Starting with Automation 360 v.24 release, delivery of пакеты is developed to be separate from the main
platform updates. This will help us respond quickly to changes and fixes required and provide the flexibility
to deliver updates in пакеты, going forward.
With this capability, new пакеты and new пакет versions can now be automatically downloaded from
Automation Anywhere Cloud when they are predictably released on a quarterly release cadence. These
downloaded пакеты become the default пакет so that customers can start using these пакет versions on
an ongoing basis as they become available.
This capability is enabled differently for Cloud and On-Premises Control Room instances, as listed in the
following table:

Seamless пакет update
capability

Cloud Control Room On-Premises Control Room

Download пакеты from
Automation Anywhere Cloud

Enabled by default and cannot
be disabled.

Disabled by default and can be
enabled.

Set downloaded пакет to
default version

Enabled by default and can be
disabled.

Enabled by default and can be
disabled.

• Пользователи Cloud: Automatic пакет download capability is now enabled across all Control Room
instances in all regions at the same time.
You can start using the latest пакеты on your current Control Room version before the Control Room
update is made available in your region.

• Пользователи On-Premises: This capability is disabled by default but it can be enabled by пакет
administrators.

We recommend that бот developers always use the latest version of the пакеты because that version
provides the latest innovations and all the code and security fixes from previous versions. However,
administrators can change this default behavior at any time and roll out the пакеты to developers
after verifying them. Эти новые версии пакет также обратно совместимы с существующей версией
платформы.
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Note that this capability has no impact on existing боты, which continue to run unchanged. Боты that
are developed with a particular пакет version will always continue to do so unless explicitly changed by
the бот developer. This provides бот developers the flexibility to adopt new пакет versions when they are
ready for it. Бот developers must explicitly edit the боты in the Bot editor view and use the new пакет
version.

Support and deprecation policy for пакеты

Support and deprecation policy for пакеты aims to provide бот longevity and reduce overall maintenance
efforts to keep боты updated. The design consideration is to minimize the бот changes required to keep
the bot functioning.

Note:  This policy is in effect from Control Room release v.23.

Пакет versions supported for a minimum of 2
years

Пакет versions that are released will continue to
be supported for a minimum of 2 years after the
release. Even after 2 years, a пакет version will
continue to be supported unless it is deprecated.
Typically, a new version of the пакет will be made
available if a пакет is deprecated. All issues and
security fixes reported for the пакет will be fixed in
the latest version, with no backporting.
You will be notified 3 months in advance when a
пакет version is planned for deprecation. If there
is a critical security vulnerability, we will make the
best effort to send an advanced notification.

Пакеты version compatibility with Bot Agent
and Control Room

Package versions and боты that use these versions
will be compatible with all the Control Room and
Bot Agent versions released within the 2 years after
the пакет version release. Боты that use these
supported package versions do not have to be
configured to be compatible with the Control Room
and Bot Agent versions.

Deprecation policy on пакет version Пакет versions will not be depreciated within the
2 years after their release unless there is a critical
security vulnerability that has to fixed. In such a
case, a new пакет version will be made available
with the fix.

Minimal бот changes The пакет version support policy aim is to minimize
the effort required to change existing боты and to
keep them functioning.
Боты using a specific пакет version do not have
to be updated to use the пакет versions if the
existing пакет version is supported. However, we
recommend that you use the latest version of the
пакет when developing the бот to increase the
longevity of the бот. The пакет versions used
in a бот will have to be updated before they are
deprecated for the бот to remain supported.
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Бот lifecycle

The design assumption for боты is that the version of the пакет used in the боты is present in the Control
Room that is used to run the боты. Before developers promote боты, we recommend that the developers
verify that the пакет version used in the боты matches the пакет version in the higher environments.
When promoting боты to higher environments (for example, testing and production) that are on a lower
software version, ensure that you include the dependent пакеты for боты. This will ensure that the target
environment has all the пакет versions required by the бот.

Note:  Some пакет versions will not be backward compatible with an earlier version of the Control Room
or Bot Agent. Therefore, refrain from using such incompatible пакет versions during the Control Room
environment update phase.

See also: Automatic package updates for On-Premises Control Room.
Related concepts
Feature deprecations affecting Automation Anywhere products on page 763
Review the features and capabilities (from Automation Anywhere or third party) that are deprecated or
nearing deprecation to understand how they affect your automation and what action is required.
Related reference
Automation 360 Cloud FAQ on page 56
Answers to frequently asked questions (FAQ) and related information provide insight into various aspects
related to Automation 360 Cloud.
Automation 360 Cloud updates on page 760
Automation 360 Cloud is a multitenant cloud service that leverages the latest best practices in delivering
web-scale SaaS to rolling out incremental updates globally using a continuous deployment pipeline.

Automation 360 Cloud for secure access and connectivity
You can develop and run боты securely using the Automation 360 Cloud access security.

High-level architecture of Cloud deployment

The following information provides a high-level workflow of the Automation 360 Cloud deployment:
1. Using a browser, you log into the Control Room and create users and roles. You perform this process

on the Automation 360 Cloud.
2. You install the Bot Agent on your Windows device to run боты locally. You perform this process on

your infrastructure.
3. Data flow between the Automation 360 Cloud and the Bot Agent on your Windows device on your

infrastructure is encrypted using TLS 1.2 (outbound port 443 only).

The following image shows the Automation 360 Cloud architecture:
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Identity and Access Management (IAM) security for user system

• When an admin user logs into the Automation 360 Control Room for the first time, the admin can
configure SAML 2.0 to connect the Automation 360 Cloud Control Room to their own Identity Provider
(IdP) so that their users can log in to the Control Room using MFA (multi-factor authentication).

• The admin can then create the required users and roles or permissions to perform certain activities
(such as developing and running боты) in the Control Room.

• The Automation 360 Control Room users can then log in through MFA and start creating and running
боты.

• Additionally, the admin can configure an allowed IP address range to manage user logins through the
Administrator settings in the Control Room.

To learn more about Automation 360 Cloud, see Начните с Cloud Automation 360 on page 832.

Secure connectivity to run боты

You run боты locally on a Windows machine on which the Bot Agent is deployed. You can download and
install the Bot Agent on your devices or deploy to a pool of virtual machines.
Before you install the Bot Agent, the following criteria must be met:
• The integrity of the device on which the Bot Agent is installed is not compromised.
• The user organization has instituted security safeguards and controls to prevent Bot Agent takeover and

system-level user breaches.
• The user environment is safe from network-based attacks such as Domain Name System (DNS) cache

poisoning, Address Resolution Protocol (ARP) spoofing, and so on.

Note:  Automation 360 Cloud includes security operation controls to check for man in the middle (MITM)
attacks and malicious intercepts.

Bot Agent installation and registration When you register your device, the Bot Agent
device is provided a JSON Web Token (JWT) to start
the registration process with the Control Room. If
the token provided by the Bot Agent device does
not match the token provided by the Control Room,
the registration process will fail. This authenticates
the client Bot Agent device to the Control Room.
In the bulk installation and registration mode of
the Bot Agent, the Bot Agent device comes online
preregistered with the Control Room URL specified
in the autoregistration.properties file.
When using the bulk registration settings, one
cannot enter or specify a fake Control Room URL
without administrator privileges on that device.
When the Bot Agent starts for the first time, it
will read the autoregistration.properties
file and register itself to the Control Room URL
specified in the properties file. By default, the
option to switch the Bot Agent registration from
one Control Room to another is disabled. Only
the Control Room administrators can enabled this
option. If someone tries to register another URL
when this option is disabled, the registration would
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fail immediately and generate an error mentioning
that says Control Room is already registered and
switching of the Control Room URL is not allowed.
By providing write access to a cache folder for the
admin only and read permissions to all other users
who can run боты, we can assure that when a бот
is downloaded to the device cache, it cannot be
manipulated to perform potentially harmful things.

Communication between Bot Agent and
Control Room

The Bot Agent device establishes a websocket
connection to the Control Room using HTTPS
(outbound port 443) and no inbound connection is
required.
• Server authentication: The Transport Layer

Security (TLS) handshake ensures that the
Common Name (CN) in the server certificate
issued by the well-known certification authority
(CA) matches the legitimate hostname as
included in the certificate chain of trust.

• Client authentication: After registration, a
valid token key is always required from the Bot
Agent to establish a connection to the Control
Room. The token is encrypted using the Bot
Agent private key and can only be decrypted by
using the Bot Agent public key that was used
when the Bot Agent device was registered to
the Control Room. The token also authenticates
the Bot Agent device every time the Bot Agent
connects to the Control Room.

Data connection between a customer's network
and the Cloud service is protected with a strong
TLS connection that leverages at least 2048-bit RSA
server certificates, 128-bit symmetric encryption
keys, and stronger TLS protocols. This secure
connection makes it virtually impossible to breach
the established TLS connection.
After the websocket connection is established, the
communication between a customer's network
and the Cloud service is secured and bidirectional.
The connection between the Bot Agent device and
the Automation 360 Cloud hosted Control Room
is permanent and automatically reestablished if
connectivity is lost. This connection is used to
download the боты to run and send operational
status information to the Control Room.

Note:  The connectivity is established only one
time and not for each бот.

Schedule боты to run Control Room users can schedule боты to run.
Compiled боты are downloaded to run on the Bot
Agent devices and operational logs are sent from
the Bot Agent devices to the Control Room.
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For the боты to run, the Bot Agent establishes an
active Windows session by authenticating as the
licensed Bot Runner user on the Bot Agent device.

Secure credentials for боты Боты that run on the Bot Agent devices need to
log in to the device using credentials. You can store
credentials securely in the Automation 360 Cloud
Control Room credential vault. Alternatively, you
can store credentials in a customer-hosted key
management system (for example, CyberArk).
When you store credentials in the customer-
hosted key management system, you must have
connectivity between the Control Room and the
customer's key management system. To provide
connectivity and allow access, you must configure
the Automation 360 Cloud IP addresses for the
specific Automation 360 Cloud region that is hosting
the Control Room in their firewall. Подробнее см.
в разделе Automation 360 IP addresses for external
integrations on page 2773.

Secure operations in Automation 360 Cloud

Automation 360 Cloud is run securely and meets compliance standards for: SOC 1, SOC 2, ISO 27001, and
HITRUST.
• For information about Automation 360 Cloud deployment and operational models, see Automation 360

Cloud Security and Data Privacy.
• For Automation 360 Cloud compliance reports, see Security and Compliance Portal.

Automation 360 Cloud Service Status site
The Automation 360 Cloud Service Status site displays real-time operational status, historical operational
status, maintenance information, and incident history for all Automation 360 Cloud services worldwide,
across all hosting regions.
Automation 360 Cloud Service Status site

How you can use the site

You can use the Automation 360 Cloud Service Status site to view various updates:

Note:  In addition to viewing updates, you can also receive updates regarding ongoing incidents and
upcoming scheduled maintenance by email or RSS feed by using the Subscribe option on the top-right
corner.

• Use the Component Summary section to view the real-time operational status of all the Cloud
services hosted from all regions worldwide.

• Use the Component Status History section to view the historical operational status of all Automation
360 Cloud services hosted across all regions worldwide.

Note:  This historical information can be traced back for a maximum of three months.
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• Use the Upcoming Maintenance - Next 14 days section to view maintenance information about
ongoing and upcoming incidents for the next 14 days.

• Use the Incident History section to view information about incidents that are resolved and scheduled
maintenance events that are completed .

Note:  In the Automation 360 Cloud Service Status site and in this documentation, the term "component"
refers to the Automation Anywhere service within a hosting region.

Real-time operational status

Automation Anywhere frequently monitors the accessibility and health of components from various
geographical regions across the world to report on the operational statuses of components in real time.
The Component Summary section provides a real-time view of the operational status of various
components.
The following table provides a list of operational statuses along with definitions and examples:

Component statuses along with definitions and examples

Component status Определение Пример

Operational All the services in the region are
operational and available.

All the Control Room URLs are
accessible, and customers can
log in to their Control Room
instances.

Informational All the services in the region are
operational but have an incident
that does not affect customers.

Under Maintenance The services in the region are
currently unavailable.

The service is undergoing a
planned maintenance event.

Degraded Performance There is an incident that affects
performance significantly.

• The service is available, but
one or more capabilities
of the service are not
performing optimally.

• Services in the region are
occasionally inaccessible or
interrupted.

• Боты in the region
occasionally fail for some
customers.
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Component status Определение Пример

Partial Outage There is a major incident
that affects a few customers
significantly.

• Services in the region
are inaccessible, or some
customers (more than 25
percent of customers in the
region) cannot log in to their
Control Room instances.

• Боты in the region fail for
some customers.

• A security or data breach
has occurred for some
customers in the region.

Major Outage There is a critical incident with
very high impact across the
region.

• Services in the region are
inaccessible, and customers
cannot log in to their Control
Room instances.

• Боты fail to run successfully
on the Control Room
instances in the region.

• A security or data breach
has occurred for all the
customers in the region.

• A Cloud region has
completely failed, triggering
a disaster recovery event.

Historical operational status

The Component Status History section provides a historical view of the availability status of all the
components over the preceding seven days. You can use the Search Components option at the top-left
corner of the section to search for the historical operational status of a specific component. You can use
the arrows on the top-right corner of the section to view the historical operational status of components,
one week at a time, for the preceding three months.
This section also provides an aggregated incident status for all the incidents for any given day. Click the
days with incidents to view a summary of uptime details along with a list of incidents reported for that day.

Note:  Planned maintenance windows are reported as incidents.

Maintenance information

Two types of incidents are monitored for and reported on the Automation 360 Cloud Service Status site:
• Planned incidents: Incidents that are primarily related to planned maintenance windows for software

updates, such as patch updates, security updates, and infrastructure updates.
• Unplanned incidents: Unplanned interruptions that result in reduced or degraded service

performance or total interruption to service availability for some or all customers.

Planned maintenance events

© 2023 Automation Anywhere. All rights reserved.     756



    Automation Anywhere - Learn

The planned maintenance window is published well in advance of scheduled events and is conducted to
improve multiple aspects of a service. A planned maintenance event is scheduled to deploy a software
update, a patch to fix an existing issue, a security patch to resolve a security vulnerability, or an
infrastructure component update to improve the reliability, resiliency, and availability of the service. Users
who are subscribed to incident notifications receive an email notification about the details of maintenance
windows.
Planned maintenance events typically last for four to six hours per geographical region when updates are
rolled out. Although the actual downtime during the update varies, completion is typically within 10 to15
minutes. If IQ Bot is in use, completion time is typically 20 to 30 minutes.
The Automation 360 Cloud Service Status site provides information about the following types of planned
maintenance events:

Planned maintenance event for deploying
Automation 360 release update

This planned maintenance event deploys new
Automation 360 software release update to the
Automation 360 Cloud. Here are the notification
fields for this software release update:

Заголовок Planned upgrade for
Automation 360 Cloud
for a region

Описание Planned upgrade for
Automation 360 to
the Automation 360
Cloud, which results in
minor interruptions to
the service during this
period.

Note:  We recommend
that you do not run
боты during this period.

Advance Notice The notification
announcing this
maintenance window is
published at least two
weeks in advance on the
Automation 360 Service
Status site. The release
notes are published in
advance of the update.

Planned maintenance event for deploying
patch (non-security) release for Control
Room

This planned maintenance event deploys
Automation 360 software patches to Automation
360 Cloudto fix existing or unknown issues. Here
are the notification fields for this patch release
update:

Заголовок Emergency patch for
Automation 360 Cloud
for a region

Описание This is a critical, non-
security patch upgrade
for Automation 360 to
the Automation 360
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Cloud, which results in
minor interruptions to
the service during this
period.

Note:  We recommend
that you do not run
боты during this period.

Advance Notice The notification
announcing this
maintenance window
is published with best
effort, in advance, on
the Automation 360
Service Status site.
The release notes are
published in advance of
the update.

Planned maintenance event for deploying
patch (security) release for Control Room

This planned maintenance event deploys
Automation 360 security fixes to Automation 360
Cloud to fix existing vulnerabilities, known security
issues, and Cloud component updates to resolve
vulnerabilities. Here are the notification fields for
this update:

Заголовок Emergency security
patch for a region

Описание This is a critical security
patch upgrade for
Automation 360 to
the Automation 360
Cloud, which results in
minor interruptions to
the service during this
period.

Note:  We recommend
that you do not run
боты during this period.

Advance Notice The notification
announcing this
maintenance window
is published with best
effort, in advance, on
the Automation 360
Service Status site
depending on how
critical the security issue
is. The release notes are
published in advance of
the update.
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Planned maintenance event for Automation
360 infrastructure updates

This planned maintenance event deploys updates
related to the Automation 360 Cloud infrastructure.
Here are the notification fields for this update:

Заголовок Planned infrastructure
upgrade for Automation
360Cloud for a region

Описание This is a planned
infrastructure upgrade
for Automation 360
Cloud, which results in
minor interruptions to
the service during this
period.

Note:  We recommend
that you do not run
боты during this period.

Advance Notice The notification
announcing this
maintenance window is
published at least two
weeks in advance on the
Automation 360 Service
Status site. The release
notes are published in
advance of the update.

Planned maintenance event for patch
(security) release for IQ Bot Hybrid Заголовок Planned upgrade for

Automation 360 Cloud
for IQ Bot Cloud servers
for a region

Описание This is a critical patch
update for IQ Bot on
the Automation 360
Cloud, which results in
interruptions to the IQ
Bot service during this
period. Access to the
main Automation 360
Cloud Control Room and
other services are not
affected.

Note:  We recommend
that you do not
schedule боты that use
IQ Bot capabilities to
start during this period.

Advance Notice The notification
announcing this
maintenance window is
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published at least two
weeks in advance on the
Automation 360 Service
Status site. The release
notes are published in
advance of the update.

Incident history

The Incident History section shows a detailed list of resolved incidents and completed scheduled
maintenance events for the preceding seven days.
The list includes the following details about each incident:
• Incident description
• Incident duration (start time, end time, and duration of the outage)
• Affected components
• Incident status updates
• Information in cases of unplanned service outages

Automation 360 Cloud updates
Automation 360 Cloud is a multitenant cloud service that leverages the latest best practices in delivering
web-scale SaaS to rolling out incremental updates globally using a continuous deployment pipeline.
Automation 360 Cloud provides updates to the Bot Agent instances running on your infrastructure. The
Bot Agent is a lightweight, Java-based, modular application that handles particular боты and their пакеты
when they are scheduled to run.
Bot Agent updates are transparent to active Bot Creator users. For operations, the Bot Agent updates
are carried out automatically, by default, without requiring administrative privileges (much like browser
updates).

Note:  This is regardless of whether the Bot Agent was installed as a system user or local user.

With each update, products such as Рабочая область RPA, Control Room, IQ Bot, Bot Insight, Discovery
Bot, and AARI have improved security and enhanced features. Application command пакеты can also be
enhanced and made available for inclusion into боты on your release cycle.
Updates are rolled out over a 3-hour maintenance window per geographical region. These maintenance
windows are posted on the Automation 360 Cloud Service Status site. Although the actual downtime
during the update varies, completion is typically within 10-15 minutes. If IQ Bot is in use, completion
time is typically 20 - 30 minutes. In general, боты run to completion during updates, with the following
scenarios being exceptions:
• The бот tags data for Bot Insight.
• Боты that run WLM.
• Credentials directly entered as command input are pulled from the Control Room at execution time.

Instead, use credential type variables.
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• Child боты: Parent/child боты run to completion because the child боты are downloaded when the
parent бот starts its run.
Exceptions:
• If a child бот is referenced using a variable parameter because the child бот requires the Control

Room to be available when the parent бот runs.
• If a child бот does not use the same global variables as the parent бот.
• If a child бот is using credential type variables.

After the Bot Agent has reconnected to the Control Room, the бот status is updated in the бот run activity
logs.
Automated Bot Agent update takes place after an agent completes any current бот run and the Bot Agent
reconnects to the Control Room.
During this short downtime, any боты scheduled to run will not be run. It is therefore recommended that
боты are not scheduled to start to run during the planned maintenance window.
The following table provides a list of regions and the day and time of their maintenance windows. The
upgrade occurs sequentially over a three week period:
• Week 1 - First rollout will begins in the AP-AUS and AP-Sing regions
• Week 2 - Second rollout begins in the EU-West1, EU-West4, LATAM, ME, S, Africa, US-East, US-Central,

and India regions
• Week 3 - Third and final rollout begins in the US-West, Canada, and Japan

Important:
Times mentioned below are in UTC (Coordinated Universal Time). To convert to your local time, refer to a
universally recognized online resource such as https://www.worldtimezone.com/.

Область Day and time in UTC

AP-AUS Wednesday, 12:00 to 15:00

AP-Sing Wednesday, 16:00 to 19:00

EU-West1 Tuesday, 20:00 to 23:00

ЕС (Запад 4) Tuesday, 20:00 to 23:00

LATAM Thursday, 02:00 to 05:00

ME Thursday, 20:00 to 23:00

S. Africa Thursday, 20:00 to 23:00

US-East Friday, 02:00 to 05:00

US-Central Friday, 02:00 to 05:00

Индия Friday, 20:00 to 23:00

US-West Monday, 02:00 to 05:00

Канада Monday, 02:00 to 05:00

Япония Monday, 16:00 to 19:00
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Note:  A small interim update might be planned to address urgent, priority updates mid-cycle between
the primary quarterly updates. These will occur on the same day of the week and time as the schedule
mentioned previously.

Regular updates

Regular updates are planned approximately every 3 months and are scheduled to occur during non-
business hours and not close to the beginning or end of a month. Notifications are posted to the Service
Status site 2 weeks in advance of the update. A notification message is also pushed to administrators in
the Control Room in advance.
You can review changes in the release notes that are made available 3 weeks before each update.

Note:  As a customer, you can use a sandbox Control Room environment to try out the next update at
least 3 weeks before the main Dev/UAT/Prod environments are updated.

Command пакеты might be updated and made the default for creating new боты. Existing боты continue
to use their existing пакет versions. New боты use the new default пакет version. However, as a user, you
can also choose to revert to the previous version.

Cloud infrastructure updates

Cloud infrastructure updates are carried out typically once every 3-month period. If these infrastructure
updates involve planned downtime for Automation 360 Cloud, notifications are posted on the Service
Status site at least 1 week in advance.

Critical patch updates

Patch updates might be required for either critical security updates or where serious issues with an update
affect the majority of Cloud customers.
Patches require a maintenance window although they typically do not require a Bot Agent update. For
patch updates, advance notice will be provided on the Service Status site.

Planned maintenance windows

Automation Anywhere offers planned update maintenance windows to enable customer operations to
support Bot Lifecycle Management. Outside of planned maintenance windows for the updates mentioned
previously, the Automation 360 Cloud availability SLA is 99.9 percent per month.

Note:  Подробнее см. в разделе Cloud Automation Agreement.

The following table provides information such as frequency, time expectation, and client action for different
types of updates:

Type of update Частота Time expectation Client action

Regular Automation
360 Control Room and
Bot Agent

3 - 4 months 3-hour window
Around 10 minutes of
downtime

Боты can run to
completion. Do not
schedule боты to start
during this 3-hour
window.
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Type of update Частота Time expectation Client action

Sandbox At least 3 weeks
prior to regular Cloud
updates

Try new features out
after the window.
Sanity-test production
боты.

Cloud infrastructure Once every 3-month
period

Varies. Scheduled on
weekends.

Боты can run to
completion. Do not
schedule боты to start
during the window.

Critical patch As needed Critical notice given

Subscribing to notifications
In the Automation 360 Cloud Service Status site, subscribe to email notifications about planned
maintenance events and unplanned incidents that affect service availability.
To subscribe to email notifications from the Automation 360 Cloud Service Status site about planned
maintenance events and unplanned incidents that affect service availability, click Subscribe on the top-
right corner of the Service Status site.
Provide your name and email address when subscribing to notifications.
You can manage your subscription by clicking Manage Existing Subscription. The system sends you
a link, by email, with which you can manage your incident notification subscription. You can select the
service and the region for which you want to receive status notifications.
To subscribe to incident notifications for the Cloud region where your services are hosted, open an
Automation Anywhere support ticket.

Personalizing the Service Status site

You can personalize the Automation 360 Cloud Service Status site by selecting the language and time zone
of your choice for showing incidents. To select language and time zone, click the gear icon on the top-right
corner.

Язык You can select a language from among seven
supported languages.

Часовой пояс When you select a time zone, the incidents from the
selected time zone will be shown.

Feature deprecations affecting Automation Anywhere products
Review the features and capabilities (from Automation Anywhere or third party) that are deprecated or
nearing deprecation to understand how they affect your automation and what action is required.

Definition:  Deprecation refers to features or capabilities available in the current (latest) release that are
planned to be removed or unsupported in a future release.
You can use the specified alternatives or updated versions when they are made available.
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Third-party feature deprecations

Upcoming: The following table lists third-party features that will be deprecated by the date mentioned:

Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

EWS API
See Upcoming API
Deprecations in
Exchange Web Services
for Exchange Online

Ongoing
deprecation

Automation 360 currently uses
EWS API in Эл. почта пакет and
Email trigger for the EWS option to
connect to Exchange Online hosted
on Azure Cloud and access emails
from Microsoft 365.
Microsoft has recommended that
customers move to a REST-based
Graph API, which is more secure and
scalable compared with the legacy
SOAP-based EWS API. Therefore
Automation 360 will provide support
for Microsoft 365 Outlook пакет
based on Graph APIs which will
enable you to switch from EWS API
to Graph API from an upcoming
release.
This deprecation by Microsoft might
impact боты for email automations
(Эл. почта пакет and Email trigger)
that connect to Exchange Online
using EWS API. Note that there
is no immediate impact on your
existing боты and they continue to
run properly.
Recommended: Update the
impacted боты by replacing each
email-related action with the
equivalent new actions in the
Microsoft 365 Outlook пакет,
planned in the upcoming release
if your боты are impacted by the
deprecation.

--
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Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

Transport Layer
Security (TLS) 1.0
and TLS 1.1

April 2023 Automation 360 Cloud deployments
currently support the following TLS
protocol versions:
• TLS 1.0
• TLS 1.1
• TLS 1.2
• TLS 1.3

However, the TLS 1.0 and TLS 1.1
protocol versions have security
vulnerabilities as per the industry
security standards. Therefore,
Automation 360 Cloud deployments
for Amazon Web Services and Google
Cloud Project will support only
the TLS 1.2 and TLS 1.3 protocol
versions.

Note:  For Automation 360 Cloud
deployments, the changes will
be effective as part of the Cloud
deployment configurations, not as
part of the Automation 360 release.

Deprecating TLS 1.0
and TLS 1.1
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Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

Manifest V2 based
extensions by Google
See also: Overview
and timelines for
migrating to Manifest
V3

January 2023 Automations that use Google Chrome
Manifest V2 based extensions will
stop working sometime after June
2023. The deprecation timelines of
Manifest V2 based extensions are
currently under review and subject to
change by Google.
• For Google Chrome Manifest V2

extensions timelines, see Manifest
V2 support timeline.

• For Microsoft Edge Manifest V2
extensions timelines, see Overview
and timelines for migrating to
Manifest V3.

This might impact customer боты
that automate web applications over
Google Chrome and Microsoft Edge.
Recommended: Switch to Manifest
V3 based extensions for Google
Chrome and Microsoft Edge.
Releases:
• Automation 360 v.26
• Version 11.3.5.8

• Chrome and
Edge Manifest V3
extensions on page
812

• Enterprise 11:
Deprecation of
Basic authentication
and MV2 extensions

• Version 11.3.5.8
Release Notes

Completed: The following table lists third-party features that are already deprecated:

Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

Basic authentication in
Exchange Online

October 2022 Боты for email automations (Эл.
почта пакет and trigger) that
connect to Exchange Online by using
IMAP, POP3, or EWS protocols with
Basic authentication will be impacted.
Recommended: Update the
impacted боты by replacing each
email-related action with OAuth 2.0.
Released:
• A пакет only release for

Automation 360 v.25
• Version 11.3.5.7 client patch

• Deprecation of
Basic authentication
in Exchange Online
on page 797

• Enterprise 11:
Deprecation of
Basic authentication
and MV2 extensions
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Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

Internet Explorer EOL June 2022 Customers who are running IE-based
боты on Windows 10 Semi-Annual
Channel are impacted.
Releases with tools to convert IE-
based боты to Microsoft Edge with IE
mode:
• Automation 360 v.24R2
• Version 11.3.5.6

Microsoft Internet
Explorer EOL
overview on page
770
Microsoft Internet
Explorer 11 EOL
FAQ on page
774

Automation Anywhere feature deprecations

Upcoming: The following table lists Automation Anywhere features that will be deprecated by the date
mentioned:

Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

V2 Repository Files
List API

June 2023 From Automation 360 v.29, the
Repository Files List API (v2/
repository/file/list) will be
deprecated.
Recommended: You can use the
/v2/repository/workspaces/
{workspaceType}/files/list

Deprecated API: v2/
repository/file/
list

Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

Descoped language
support

June/July
2023

Beginning with Automation 360 v.29,
the User Interface for Automation
Anywhere product will no longer
support Italian, Russian, and
Simplified Chinese languages.
In addition, updated release
documentation will no longer be
available in these three languages
though older documentation will be
accessible.

--

Completed: The following table lists Automation Anywhere features that are already deprecated:
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Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

IQ Bot Extraction
пакет

October 2022 From Automation 360 v.25, the
IQ Bot Extraction пакет no longer
supports pretrained machine learning
model for invoice data extraction
but will continue to support learning
instance group based-training
extraction.
Recommended: Use the new
command пакет called Document
Extraction, released in v.25 as part of
Document Automation.
Released: Automation 360 v.25

Move from IQ Bot
Extraction пакет to
Document Automation
on page 1671

IQ Bot - Tesseract
OCR v3

October 2022 For all existing learning instances
trained using Tesseract OCR v3,
we recommend that you plan to
train them with alternative OCRs
(including Tesseract4 OCR) before
you update to v.26. Note that
Automation 360 IQ Bot Cloud
customers will receive the v.26
release by default from October
2022.
Released: Automation 360 v.26

--

G-Suite Apps September
2022

From Automation 360 v.26, the
GSuite Apps пакет no longer
supports using the Connect and
Disconnect actions to establish a
connection with the Google server
and automate tasks.
Recommended:For specific G-Suite
applications, the functionality of the
G-Suite Apps пакет is available in the
following G-Suite пакеты:
• Google Диск
• Google Календарь
• Google Таблицы

To automate tasks, in the appropriate
G-suite пакет, use the corresponding
Connect and Disconnect actions.

Using the Connect
action for Google
packages on page
1614
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Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

Human-Bot
Collaboration 11.3.x

August 2020 Human-Bot Collaboration (HBC)
11.3.x was deprecated from August
2020 with the release of Enterprise
A2019.15.
Recommended: Migrate to
Automation 360 to use the
Automation Anywhere Robotic
Interface (AARI) that includes
Desktop and Web.

Note:  For this migration, there is no
automated migration path between
HBC 11.3.x and AARI because of an
absence of parity between the two
products (including sets of features).

New: Automation
Anywhere Robotic
Interface (AARI) on
page 2120
Deprecated: :

Automation
Anywhere Mobile app

July 2022 The Automation Anywhere Mobile
app is deprecated and will not be
updated to subsequent versions
of iOS and Android. The mobile
app is no longer available and no
further support will be offered. A
replacement product is currently not
available.

Archived
Documentation
(PDF): EN-US

V2 Activity List API June 2022 From Automation 360 v.25, the
Activity List API (v2/activity/
list) is deprecated.
Recommended: With the newly
implemented Activity List API (v3/
activity/list), you can return
the job executions without call back
and бот output information.

Note:  If you want to get
the botOutVariables or
callbackInfo, use /v3/
activity/execution/{id} Bot
Execution Orchestrator API.

New API:
Activity List v3/
activity/
listBot Execution
Orchestrator API
Deprecated API:
v2/activity/
list
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Feature or capability Deprecation
date

Customer impact and
recommendation

Resources

Боты RPA для Excel January 2022 Боты RPA для Excel has been
deprecated. The plug-in is no longer
available to download as a product.
However, support will be offered to
current customers already using the
product.
A replacement product as a plug-in
for Microsoft Excel is not available.
However, as an alternative, new
customers can develop боты for
Excel within the Automation 360
Рабочая область RPA and use input
variables to allow specifying file
names, worksheets, and ranges for
боты to operate on. In Боты RPA
для Excel, this action was triggered
from within the Excel application,
whereas now, this action is taken
from the Automation Anywhere
Control Room.

Documentation:
Archived docs for RPA
Bots for Excel v2.0

See also: Automation 360 software lifecycle policy on page 746
Related concepts
Automation 360 software lifecycle policy on page 746
Automation Anywhere software lifecycle policy aims to make innovations and enhancements available to
you quickly. Through this policy, we provide you predictability, quality, and importantly nondisruptive access
to the latest innovations and enhancements so that you can control when and how you want to adopt
these enhancements.
Deprecation of Basic authentication in Exchange Online on page 797
Microsoft will permanently disable Basic authentication for specific protocols in Exchange Online starting
from October 1, 2022. This impacts customers running бот for email automation that connect to Exchange
Online using IMAP, POP3, or EWS protocols with Basic authentication.
Chrome and Edge Manifest V3 extensions on page 812
As Google will deprecate Manifest V2 extensions , this might impact your existing automations that use
the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers. We have published
Manifest V3 extensions with the Automation 360 v.26 release to help you start switching to Manifest V3
extensions.
Microsoft Internet Explorer EOL overview on page 770
Microsoft has announced retiring Internet Explorer (IE) for certain versions of Windows operating systems
and recommends impacted users to move their apps or websites running on IE to Microsoft Edge with IE
mode.

Microsoft Internet Explorer EOL overview
Microsoft has announced retiring Internet Explorer (IE) for certain versions of Windows operating systems
and recommends impacted users to move their apps or websites running on IE to Microsoft Edge with IE
mode.
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While support for the Control Room (Automation 360 v.25) on IE will end, new and advanced features will
be added to Automation 360 v.24R2 patch that will be supported on alternative browsers.
To ensure your existing IE боты are supported on Microsoft recommended browsers, such as Microsoft
Edge with IE mode, based on the release you have installed, we recommend that you update to
Automation 360 v.24R2 patch. To support conversion of IE боты to Microsoft Edge with IE mode, the
following tools are available in this patch:
• Bot Scanner to scan Enterprise 11 боты for IE usage. This helps you to plan your efforts in the IE бот

conversion process whether you continue on Enterprise 11 or migrate to Automation 360.

Обзор Bot Scanner on page 1166 | Scan Enterprise 11 or 10 боты using Bot Scanner on page 1168
• Bot Migration Wizard to support conversion of IE боты to Microsoft Edge with IE mode. This will help

Enterprise 10 or Enterprise 11 users to migrate боты to Automation 360 and convert the IE боты at the
same time.
Bot Migration Wizard on page 1223

• Update Bot wizard to help Automation 360 new users as users who have migrated from Enterprise 10
or Enterprise 11 and want to convert their IE боты to Microsoft Edge with IE mode.
Update Bot wizard for converting IE боты on page 791

See the following video on preparing your automations for IE EOL:

Update scenarios

• If you are using Enterprise 10, to update your IE боты to Microsoft Edge with IE mode, you can
choose one of the following methods:
• Upgrade to Automation Anywhere Enterprise Version 11.3.5.6 that supports IE бот conversion

to Microsoft Edgewith IE mode, convert your IE боты to Microsoft Edge with IE mode, and later
migrate to the latest Automation 360 release.

• Upgrade to Automation 360 v.24R2 patch, migrate your IE боты and update the IE боты to
Microsoft Edge with IE mode.

• If you are using Enterprise 11 and are yet to migrate to Automation 360, update to Automation
Anywhere Enterprise Version 11.3.5.6, which supports Microsoft Edge with IE mode. You can then
migrate to Automation 360.

Поддерживаемые для миграции версии Control Room on page 1143
• If you are using Enterprise 11 and plan to complete migration to Automation 360 before IE EOL, you

can migrate to the latest Automation 360 v.24R2 patch, which supports Microsoft Edge with IE mode.
• If you are using Enterprise 11 and plan to complete migration to Automation 360 after IE EOL, you can

use one of the following methods:
• Update to the latest Automation 360 release, convert the migrated боты created in IE to Microsoft

Edge with IE mode.
• Update to the latest Enterprise Client version that supports Microsoft Edge with IE mode and convert

the pending боты created in IE to Microsoft Edge with IE mode in Enterprise 11, and later migrate
these боты to the latest Automation 360 release.

• If you are using Automation 360 v.24 On-Premises or earlier and have created IE боты, you can update
to Automation 360 v.24R2 patch to convert your IE боты to Microsoft Edge with IE mode.

Note:  To ensure that your боты continue to run on Internet Explorer after EOL, Microsoft recommends
that you register your site or application running on Internet Explorer to the Microsoft Site List manager.
См. раздел Enterprise Mode and the Enterprise Mode Site List.
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For additional information on different upgrade scenarios, see Enterprise 11 and upcoming Internet Explorer
11 EOL FAQ | Microsoft Internet Explorer 11 EOL FAQ on page 774

IE бот update workflow

Update from Automation 360 to Automation
360 On-Premises

1. Update to the latest Automation 360 release.

Обновление до последней версии Automation
360 on page 1070

2. Set up Automation 360 Bot Runner for бот
updates.

Установка Bot Agent и регистрация устройств
on page 1046

3. Back up the Control Room repository.
Restore боты from Git repository on page 2777

4. Identify боты created in Internet Explorer using
the Bot Scanner.
Scan Enterprise 11 or 10 боты using Bot Scanner
on page 1168

5. Convert the боты created in IE to Microsoft
Edge with IE mode using the Update Bot
wizard.
Update Bot wizard for converting IE боты on page
791

6. Analyze the updated боты report using the
Update Bot wizard.
Viewing conversion details for Internet Explorer
боты on page 794

7. Verify that the updated боты can run or be
deployed.

Планирование бот on page 2631 | Run a бот
on page 2007

Important:  Before you deploy your боты,
register your site or application running on
Internet Explorer to the Microsoft Site List
manager. Подробнее см. в разделе Enterprise
Mode and the Enterprise Mode Site List.

Note that you can convert your IE боты
to Microsoft Edge with IE mode in one
environment (for example, DEV) and then
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move these боты to another environment (for
example, UAT and PROD) without updating the
боты in each environment.

Upgrade from Enterprise 11 to latest
Automation 360 On-Premises

1. Upgrade from Enterprise 11 to the latest
Automation 360 release that supports Microsoft
Edge with IE mode.

Подготовка к миграции с Enterprise 11 в
Automation 360 On-Premises on page 1198

2. Set up Automation 360 Bot Runner for бот
updates.

Установка Bot Agent и регистрация устройств
on page 1046

3. Back up the Control Room repository.
Restore боты from Git repository on page 2777

4. Identify the боты created in Internet Explorer
using the Bot Scanner.
Scan Enterprise 11 or 10 боты using Bot Scanner
on page 1168

5. Migrate Bot Runner and IE боты from
Enterprise 11 to Automation 360.
Bot Migration Wizard on page 1223

6. View the бот migration report.

Просмотр отчетов о переносе данных on
page 1315

7. Verify that the migrated боты can run or be
deployed.

Планирование бот on page 2631 | Run a бот
on page 2007

Related concepts
Microsoft Internet Explorer 11 EOL FAQ on page 774
Microsoft has announced end-of-life (EOL) for Internet Explorer beginning June 2022 and recommends
using Microsoft Edge or Microsoft Edge in Internet Explorer (IE) mode. Это может повлиять на
автоматизации (боты) (в зависимости от используемой в настоящее время операционной системы, в
которой запускаются боты).
Microsoft Internet Explorer 11 EOL FAQ on page 774
Microsoft has announced end-of-life (EOL) for Internet Explorer beginning June 2022 and recommends
using Microsoft Edge or Microsoft Edge in Internet Explorer (IE) mode. Это может повлиять на
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автоматизации (боты) (в зависимости от используемой в настоящее время операционной системы, в
которой запускаются боты).
Related reference
Заметки о выпуске Automation 360 v.24R2 для прекращения поддержки Internet Explorer 11 on page
263
Related information
Enterprise 11 and upcoming Internet Explorer 11 EOL FAQ

Microsoft Internet Explorer 11 EOL FAQ
Microsoft has announced end-of-life (EOL) for Internet Explorer beginning June 2022 and recommends
using Microsoft Edge or Microsoft Edge in Internet Explorer (IE) mode. Это может повлиять на
автоматизации (боты) (в зависимости от используемой в настоящее время операционной системы, в
которой запускаются боты).
Подробнее см. в представленной ниже таблице.

Операционная система Microsoft боты Automation 360 и Enterprise 11

Лицензия Windows 10 Semi-Annual Channel Update боты to use a compatible browser.
Список поддерживаемых браузеров см. в
разделе Требования к браузеру для доступа к
Рабочая область RPA on page 872.

Все другие поддерживаемые операционные
системы

Нет непосредственного влияния

Начиная с Automation 360 v.25, вам будет предложено получать доступ к Control Room с
помощью альтернативного поддерживаемого браузера, такого как Google Chrome или Microsoft
Edge (Chromium), вместо Internet Explorer. Доступ в Control Room с помощью Internet Explorer
будет невозможен. By aligning with the Microsoft strategy for browser support, we can provide you
with enhanced functionality that latest browsers such as Google Chrome and Microsoft Edge make
technologically possible.

Общие часто задаваемые вопросы

Как узнать, повлияет ли на мою работу
прекращение поддержки Internet Explorer?

Чтобы оценить, повлияет ли на вас прекращение
поддержки Internet Explorer, вам нужно сделать
следующее.
• Проверьте, есть ли у вас базовые устаревшие

приложения или веб-сайты, которые
работают только с Internet Explorer и
с которыми нельзя работать в других
браузерах.

• Проверьте, установлена ли на устройстве, на
котором запущен бот, версия Windows 10 с
лицензией Semi-Annual Channel (SAC).
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Если к вам применимы оба вышеуказанных
положения, то прекращение поддержки Internet
Explorer повлияет на вашу работу.

Зачем нужно это изменение? Корпорация Microsoft недавно объявила о
прекращении поддержки Internet Explorer
с 15 июня 2022 г. для некоторых версий
операционных систем Windows.
Хотя мы прекращаем поддержку Control Room
в Internet Explorer, мы продолжим добавлять
новые и расширенные функции, которые будут
поддерживаться в альтернативных браузерах.

Требования к браузеру для доступа к Рабочая
область RPA on page 872 | Internet Explorer EOL

Когда прекратится поддержка? Начиная с выпуска Automation 360 v.25, любому
пользователю, пытающемуся получить доступ
к Control Room посредством Internet Explorer,
будет предложено использовать альтернативные
браузеры, такие как Google Chrome или Microsoft
Edge (Chromium).

Могу ли я подключиться к Control
Room Enterprise 11 или Enterprise 10?

Вы можете продолжать использовать
Internet Explorer для подключения к Control
Room Enterprise 11.

А что насчет автоматизации, уже
созданной с использованием Internet
Explorer?

Microsoft планирует с июня 2022 года прекратить
поддержку Internet Explorer в некоторых
операционных системах. Если это изменение
повлияет на вашу работу, вам следует
запланировать обновление своих автоматизаций,
чтобы перейти на использование других
браузеров, таких как Microsoft Edge (Chromium).
См. Internet Explorer EOL, чтобы ознакомиться
со списком операционных систем Windows,
поддерживающих Internet Explorer.
Подробнее об обновлениях автоматизации
на основе сценариев см. в разделе Часто
задаваемые вопросы по миграции on page 776.

Влияет ли EOL на мои запущенные
автоматизации, если они работают в
версиях ОС, отличных от Windows 10
Professional или Enterprise,
лицензированных через Semi-Annual
Channel (SAC)?

Нет, ваши автоматизации, если они работают в
версиях ОС, отличных от Windows 10 Professional
или Enterprise, лицензированных через SAC, не
будут затронуты. Подробнее см. в разделе часто
задаваемых вопросов Microsoft.
Internet Explorer EOL

В моей организации используются
устаревшие приложения и веб-сайты,
работа которых основана на Internet
Explorer 11, которые автоматизированы с
помощью Automation 360. Мы планируем
перенести наши устаревшие приложения
в Microsoft Edge в режиме Internet Explorer
до даты наступления EOL. Что будет с

После перемещения старых приложений в
Microsoft Edge в режиме Internet Explorer ваши
автоматизации, которые были созданы в Internet
Explorer 11, не будут работать, пока вы не
отредактируете и не настроите их работу в
Microsoft Edge в режиме Internet Explorer.
Возможно, вам придется снова создать снимки
объектов и обновить соответствующие действия
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моими существующими автоматизациями,
основанными на Internet Explorer 11?

над этими объектами, чтобы автоматизация
могла успешно работать в Microsoft Edge в
режиме Internet Explorer.

Мое приложение работает в Microsoft
Edge в режиме Internet Explorer.
Могу ли я создавать и запускать
объектно-ориентированные автоматизации
в Microsoft Edge в режиме Internet Explorer
с использованием Automation 360?

Да, начиная с Automation 360 v.23,
объектно-ориентированные автоматизации
поддерживаются для Microsoft Edge в режиме
Internet Explorer. Вы можете записывать
объекты и выполнять различные действия,
используя Universal Recorder для автоматизации
приложений, работающих в Microsoft Edge в
режиме Internet Explorer.

Note:  Отдельного расширения подключаемого
модуля не требуется. Вы также можете
использовать расширение подключаемого
модуля Microsoft Edge для вашего браузера
Microsoft Edge в режиме Internet Explorer.

Предоставляет ли Automation
Anywhere какой-либо инструмент для
преобразования средств автоматизации,
использующих Internet Explorer, для
работы в Microsoft Edge?

Microsoft рекомендует пользователям
использовать Microsoft Edge в режиме
совместимости с Internet Explorer. Мы
предоставим утилиту для преобразования
автоматизаций, использующих Internet Explorer,
для применения Microsoft Edge в режиме
совместимости с Internet Explorer.

Часто задаваемые вопросы по миграции

Каковы рекомендации для пользователей
Automation 360 по работе с общедоступной
версией инструмента преобразования?

For Automation 360 users, we are planning a
patch release on Automation 360 v.24 for On-
Premises and Cloud users. You must apply this
patch to take advantage of the support for Microsoft
Edge with Internet Explorer mode. This patch
contains packages that are certified on Microsoft
Edge in Internet Explorer mode and a бот update
wizard. Вы можете обновить боты вручную
или использовать мастер обновления бот для
массового обновления боты и подготовки
к работе в Microsoft Edge в режиме Internet
Explorer.

Note:  Пользователи On-Premises могут получить
ранний доступ к этому исправлению, чтобы
протестировать его в среде разработки.

Каковы рекомендации для пользователей
Enterprise 11 по работе с общедоступной
версией инструмента преобразования?

Для пользователей Enterprise 11 мы планируем
выпустить исправление для версии Version
11.3.5.x для поддержки работы Microsoft Edge
в режиме Internet Explorer. You must update
to the latest version to take advantage of this
patch. Вместе с этим исправлением также
будут выпущены утилита преобразования и
улучшенный Bot Scanner. With the enhanced
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Bot Scanner, you can get statistics on the usage
of Internet Explorer in your боты so that you can
plan and devise an overall conversion strategy.
You can either manually update your боты or use
the conversion utility to convert your боты in bulk
to work with Microsoft Edge in Internet Explorer
mode.

Note:  You can get early access to this patch to
test it in the development (dev) environment.

If you are migrating from Enterprise 11 to
Automation 360, you can combine the migration
and conversion of your боты to use Microsoft Edge
in Internet Explorer mode in a single operation after
updating to the Automation 360 v.24 patch.

What options are available for users
to maintain business continuity if their
automations are being affected by the
Internet Explorer EOL?

You can maintain business continuity by choosing
one of the following options:
1. Можно изменить лицензию вашей версии

Windows с Semi-Annual Channel (SAC) на
Long-Term Servicing Channel (LTSC).
Подробнее см. в разделе Internet Explorer
EOL.

2. Можно обновить версию операционной
системы Windows для устройства, на
котором выполняются автоматизации, до
версии, отличной от Windows 10 SAC.
Подробнее см. в разделе Internet Explorer
EOL.

3. Manually edit the affected боты by recapturing
the application objects by using supported
browsers (other than Internet Explorer) and
change the window titles, variables, or any of
the corresponding actions that are browser-
specific. Подтвердите свою автоматизацию
и запустите обновленные боты в целевых
приложениях в выбранном браузере.

Note:  Сюда не относятся перенесенные
боты Enterprise 11 и Enterprise 10, которые
используют команду Средство веб-записи.

4. Повторно создайте боты, заменив старые
с помощью любого из поддерживаемых
браузеров, например Microsoft Edge или
Google Chrome.

5. Используйте инструмент преобразования,
предоставленный Automation Anywhere,
чтобы преобразовать боты и перейти от
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Internet Explorer к работе в Microsoft Edge в
режиме Internet Explorer.

Note:  The tool cannot be used to convert
боты built in Internet Explorer to other
supported browsers, such as Google Chrome,
Microsoft Edge (Standard mode), or Mozilla
Firefox.

После обновления Windows, запросы
Internet Explorer перенаправляются
в Microsoft Edge. Будет ли режим IE
устанавливаться автоматически или его
нужно устанавливать вручную?

• Подход, рекомендуемый корпорацией
Microsoft: зарегистрируйте свой сайт или
приложение, запускаемые в Internet Explorer,
в Microsoft Site List Manager.
Подробнее см. в разделе Enterprise Mode and
the Enterprise Mode Site List.

• Кроме того, с помощью настроек
совместимости Microsoft Edge с IE в браузере
Microsoft Edge можно составить список
определенных веб-сайтов, которые будут
открываться только в режиме IE. Обратите
внимание, что эти настройки необходимо
обновлять каждые 30 дней.

Migration scenario A: If you are new to Automation 360 and have боты built using Internet Explorer,
or if you have migrated from Enterprise 11 or Enterprise 10 to Automation 360 and have боты built using
Internet Explorer, review the following information.

Что нужно сделать, чтобы автоматизации,
созданные на основе Internet Explorer,
продолжали работать после прекращения
поддержки Internet Explorer?

Чтобы обеспечить работу автоматизаций после
прекращения поддержки Internet Explorer,
необходимо сделать следующее.
• Зарегистрируйте свой сайт или приложение,

запускаемые в Internet Explorer, в Microsoft
Site List Manager. Подробнее см. в разделе
Enterprise Mode and the Enterprise Mode Site List.

• Update Automation 360 to the latest patch on
Automation 360 v.24 release with support for
Microsoft Edge with Internet Explorer mode.

• Используйте мастер обновления бот для
преобразования каждого бот, запускаемого
в Internet Explorer, и перехода к работе в
Microsoft Edge в режиме Internet Explorer.
• Боты, которые не используют команды,

связанные с Internet Explorer, не будут
преобразованы.

• Если обновление бот завершено без
ошибок, то в общедоступном репозитории
Control Room будет создана новая версия
бот.

• Check the update бот report to see whether
you need to review the updated бот or take any
action.
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• Запустите бот после обновления, чтобы
убедиться, что бот нормально работает в
Microsoft Edge в режиме Internet Explorer.

I am using an earlier version of Automation
360 On-Premises. Can I directly update to
Automation 360 v.24 patch release or should
I manually uninstall the previous version and
install the new patch version?

Yes, you can directly update your existing
Automation 360 version to the latest Automation
360 v.24 patch release.
Note that we support directly updating from
n-3 releases (where n is the latest release). For
updating from a version of Automation 360 earlier
than that, you must perform a multistep update.
For example, if you are on Automation 360 v.19,
you must first update to Automation 360 v.22 and
then to Automation 360 v.24.

Do I need to update my Automation 360 Bot
Agent?

Yes, the Bot Agent needs to be updated.
Starting from the Automation 360 v.24 release, Bot
Agent update is optional with some releases.

Migration scenario B: Если сейчас вы используете Enterprise 11 или Enterprise 10 и планируете
перейти на Automation 360, просмотрите приведенную ниже информацию.

Я еще не начал миграцию в Automation
360. Что вы порекомендуете для
планирования миграции?

Миграция на Automation 360 предполагает
преобразование боты Enterprise 11 или Enterprise
10 в совместимый формат Automation 360 для
нормальной работы преобразованного бот в
Automation 360.
Если эти боты автоматизированы с
использованием Internet Explorer 11, тогда вам
нужно будет выполнить действия, необходимые
для дальнейшего преобразования этих боты
для работы в Microsoft Edge в режиме Internet
Explorer, и выполнить валидацию боты в новом
браузере.
Если вы используете Enterprise 11 и
прекращение поддержки Internet Explorer
повлияет на вашу работу, мы рекомендуем
продолжить использование Enterprise 11 и
преобразовать боты, которые относятся к
Internet Explorer, для работы в Microsoft Edge
в режиме Internet Explorer, чтобы вы могли
выполнить тестирование и валидацию боты до
прекращения поддержки.
Подробнее об инструменте преобразования
см. в разделе Enterprise 11 and upcoming Internet
Explorer 11 EOL FAQ. Миграция на Automation 360
может быть запланирована на более поздний и
удобный для вас срок.
Если вы используете Enterprise 10 и
прекращение поддержки Internet Explorer
повлияет на вашу работу, мы рекомендуем
сначала выполнить миграцию на Enterprise 11
и преобразовать боты, которые относятся к
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Internet Explorer, для работы в Microsoft Edge
в режиме Internet Explorer, чтобы вы могли
выполнить тестирование и валидацию боты до
прекращения поддержки.
Подробнее об инструменте преобразования
см. в разделе Enterprise 11 and upcoming Internet
Explorer 11 EOL FAQ. Миграция на Automation 360
может быть запланирована на более поздний и
удобный для вас срок.
Для любых новых боты, которые вы планируете
создать в Enterprise 11 или Enterprise 10, мы
рекомендуем создать их в Automation 360,
используя любой из поддерживаемых браузеров,
чтобы минимизировать влияние от прекращения
поддержки Internet Explorer.

Migration scenario C: Если сейчас вы используете Enterprise 11 или Enterprise 10 и находитесь в
процессе миграции на Automation 360, просмотрите приведенную ниже информацию.

Я выполнил миграцию нескольких боты
на Automation 360, которые используют
Internet Explorer, и есть несколько боты,
которые ожидают миграции на Enterprise
11 и которые используют Internet Explorer.
Каковы ваши рекомендации относительно
поддержания двух параллельных сред?

Если вы находитесь в процессе миграции и
поддерживаете две параллельные среды, где
есть боты, использующие Internet Explorer
в Enterprise 11 и Automation 360, то нужно
убедиться, что эти боты преобразованы для
работы в Microsoft Edge в режиме Internet
Explorer в соответствующих средах. Это
требуется на случай, если вы не успеете
завершить миграцию боты Enterprise 11 на
Automation 360 до прекращения поддержки
Internet Explorer.
For Enterprise 11 боты based on Internet
Explorer, upgrade your Enterprise 11 to the
latest Version 11.3.5.x patch release, which
supports Microsoft Edge with Internet Explorer
mode. После обновления используйте
утилиту преобразования Enterprise 11 для
преобразования этих боты для работы в
Microsoft Edge в режиме Internet Explorer, чтобы
боты могли работать в Enterprise 11 даже после
прекращения поддержки Internet Explorer.
Similarly, for Automation 360 боты based on
Internet Explorer, update to the latest Automation
360 v.24 patch release, which supports Microsoft
Edge with Internet Explorer mode. After the
update, use the Automation 360 бот update wizard
to convert these боты in Microsoft Edge with
Internet Explorer mode so that these боты continue
to run in Automation 360 even after Internet
Explorer EOL.
Позже вы сможете решить, когда выполнить
миграцию боты Enterprise 11, преобразованных
для работы в Microsoft Edge в режиме Internet
Explorer, на Automation 360. Если вы решите
сделать так, обратите внимание, что вы можете
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использовать мастер миграции Бот Automation
360 без параметра Преобразовать боты,
созданные с помощью IE, для работы в
Edge в режиме IE.
Подробнее см. в разделе Bot Migration Wizard on
page 1223.

Note:  Для боты Enterprise 10, использующих
Internet Explorer, мы не планируем выпускать
исправление для Enterprise 10, которое
поддерживает Microsoft Edge в режиме Internet
Explorer. Поэтому пользователи Enterprise 10
должны убедиться, что их боты, использующие
Internet Explorer, перенесены в исправление для
выпуска Automation 360 v.24.

Как я могу определить, какие боты
используют команды или действия,
относящиеся к Internet Explorer, и,
следовательно, требуют преобразования
для работы в Microsoft Edge в режиме
Internet Explorer?

Для боты Enterprise 11 вы можете запустить
утилиту Bot Scanner с возможностью
сканирования боты для проверки использования
Internet Explorer. Эта утилита создает отчет,
в котором перечислены все боты, которые
используют команды, относящиеся к Internet
Explorer.
В настоящее время для боты Automation 360
недоступен инструмент сканирования боты
и создания отчета об использовании Internet
Explorer.

Do I need to manually change the бот after
it is migrated to Automation 360 using the
Bot Migration Wizard along with the Convert
боты built using IE to Edge with IE mode
option?

Yes, only for боты that are migrated to Automation
360 with Action Required or Review Required
messages. Review the messages in the Migration
Report that suggest that the user edit the бот, for
example, if the бот uses a reference of Internet
Explorer in the window title through a variable, file,
and so on.

Если у вас возникнут дополнительные вопросы об этом изменении, обратитесь к назначенному вам
CSM или в службу поддержки.

Известное поведение и ограничения

The following table lists known behavior and limitations that apply to боты migrated from Enterprise 11 to
Automation 360 and to Automation 360 боты that run on Microsoft Internet Explorer and are converted to
Microsoft Edge with IE mode.

Описание Applies to
Enterprise 11 to
Automation 360
(migration)

Applies to
Automation 360
to Automation
360 (updating)

The бот conversion utility updates only боты that use
Internet Explorer for automations and does not update
боты that use other browsers.

Да Да

© 2023 Automation Anywhere. All rights reserved.     781



    Automation Anywhere - Learn

Описание Applies to
Enterprise 11 to
Automation 360
(migration)

Applies to
Automation 360
to Automation
360 (updating)

For web pages or URLs to open in Microsoft Edge with
Internet Explorer mode, you must register your site or
application running on Internet Explorer to Microsoft Site
List Manager or Group Policy within your organization.
Enterprise Mode and the Enterprise Mode Site List

Да Да

The Open Program/File command that contains a variable
to store the location of the program or file property is not
migrated or converted to use Microsoft Edge with Internet
Explorer mode. If the variable is pointing to Internet
Explorer, update it to point to Microsoft Edge browser
instead.

Да Да

The following commands are not migrated or converted
because browser components such as the menu bar, status
bar, favorites bar, command bar, and other non-web page
components differ in each browser. This can potentially
impact captured screens or properties of the actions. We
recommend that you review and recapture the screen or
update the properties if required.
• Распознавание изображений
• Распознавание текста (OCR)
• Мышь
• Ожидать> Wait for screen (Menu/Non-HTML objects)
• Экран
• Средство записи
• Интеграция приложений > Capture area

Да Да

Keystroke action that is based on the menu bar of a
browser is not migrated or converted.

Да Да

For Мышь commands such as Click, Move or Scroll,
due to the difference in header bar height in Internet
Explorer and Microsoft Edge with Internet Explorer mode,
there might be an incorrect Y-axis after the migration or
conversion.

Note:  This difference applies only to the Y-axis and not X-
axis.

Да Да

In the Распознавание изображений command, when the
target image is on the lower and upper boundaries of the
source image, the command is not migrated or converted
because of the difference in the height of the header bar
in Internet Explorer and Microsoft Edge browsers. The
following target actions are impacted: Right click, Left
click, and Double click.

Да Да
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Описание Applies to
Enterprise 11 to
Automation 360
(migration)

Applies to
Automation 360
to Automation
360 (updating)

Review and recapture all commands, except
Распознавание изображений that captures window
coordinates with negative values, after migration or
conversion.

Note:  In Enterprise 11, the coordinates are captured
the top-left of the screen at 0, 0. In Automation 360, the
coordinates are captured as negative values.

Да Да

Due to differences in the height of the header bar in
Internet Explorer and Microsoft Edge with Internet Explorer
mode, the output of the actions might not be as expected.
The following commands are impacted:
• Распознавание текста (OCR)> Capture area
• Мышь

• Button: Left button, Middle button, Right button
• Event: Click, Double click, Button down, Button up

• Экран> Capture area

Да Да

Window titles with regular expression variables containing
partial text from Internet Explorer might be converted
to the corresponding title in Microsoft Edge. However,
sometimes the conversion might not happen. Пример.
• Internet
• .Int,
• Int
• Expl*
• .Expl
• Internet Exp

Да Да

Using the Microsoft registry setting, if you have changed
the default text of the Internet Explorer window title bar to
your preferred text, the changes applied on the title bar are
not available after conversion.

Да Да

In the Open Program/File, if you have used the
taskkill /F /IM iexplore.exe command to
terminate Internet Explorer, then after conversion, when
you run the бот, it will forcefully terminate msedge.exe.
But when you run the бот for the second time, it will
display a Microsoft Edge Closed Unexpectedly
error message. We recommend that you avoid the use of /
F so that the боты run seamlessly.

Да Да

© 2023 Automation Anywhere. All rights reserved.     783



    Automation Anywhere - Learn

Описание Applies to
Enterprise 11 to
Automation 360
(migration)

Applies to
Automation 360
to Automation
360 (updating)

Local HTML files are not supported for loading in Microsoft
Edge with Internet Explorer mode through Enterprise Site
List Manager.
Обходное решение. You can deploy the local HTML file
in localhost.
Пример. The file:///C:/SampleHTML/sample.html
URL will be replaced with https://localhost/
SampleHTML/sample.html

Да Да

The wait for the browser does not work for Microsoft Edge
with Internet Explorer mode for commands such as Мышь,
Insert Keystrokes, or Средство записи. After conversion,
the User32 API does not return the child window list. As a
result, it cannot find the page Microsoft Edge with Internet
Explorer mode.

Да Да

Object Cloning commands developed on a Citrix
environment with Xen App Remote Agent and Microsoft
Edge with Internet Explorer mode are not supported.
Object Cloning commands developed on Silverlight and
Flash technologies and Microsoft Edge with Internet
Explorer mode are not supported.

Да Не применимо

• Object Cloning commands (with coordinates play mode)
where Internet Explorer based toolbar is enabled and
locked are not migrated or converted.

• Object Cloning commands (with coordinates play
mode) are not migrated or converted because browser
components such as menu bar, status bar, favorites bar,
command bar, and other non-web page components
differ in each browser. This can potentially impact the
captured screens or the properties of the actions. We
recommend that you review and recapture the screen or
update the properties if required.

• Due to the difference in the height of the header bar
in Internet Explorer and Microsoft Edge with Internet
Explorer mode, an incorrect Y-axis might occur after the
migration or conversion. This difference can be seen in
Get text, Set text, Left click, Right click, Middle
click, Double click of the coordinates play mode.

Note:  This difference applies only to the Y-axis and not
X-axis.

Да Нет

Migrated боты with Мышь Click command might not work
as expected when the Relative to property is Screen. This
is because of the difference in the offset of the address bar
between Internet Explorer and Microsoft Edge.

Да Да
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Описание Applies to
Enterprise 11 to
Automation 360
(migration)

Applies to
Automation 360
to Automation
360 (updating)

Objects captured on Internet Explorer using Standard or
Legacy technology in the Object Cloning command will not
work after migration or conversion.

Да Нет

The commands that store window titles with wildcard
characters such as *Applet* are based on the Internet
Explorer browser window with Web Java technology. If
you have selected the None of the above option for
such commands, note that the commands will not work in
Microsoft Edge with IE mode as these are not migrated to
Edge.

Да Нет

Bot Scanner does not count the commands that use
variables to store the window title as part of the statistics.
However, these commands are displayed in the Review
Required tab so you can review these commands
manually to verify if the window title is based on the
Internet Explorer browser window.

Нет Да

User Interface (UI) based and window triggers with
Internet Explorer based window title are not migrated or
converted.

Нет Да

Средство записи developed on a Citrix environment with
Xen App Remote Agent, and Microsoft Edge with Internet
Explorer mode is not supported.
Средство записи actions developed on Silverlight and Flash
technologies and Microsoft Edge with Internet Explorer
mode is not supported.

Не применимо Да

For the Bot Migration Wizard and Update Bot wizard,
when you select the Bot Assistant screen to view the
migration review and action messages, the review message
is not displayed based on the version. In the Update Bot
Assistance menu, the review message is overridden by
the migration review message.

Нет Да

When you use the Update Bot wizard to convert Automation
360 боты that run on Microsoft Internet Explorer to
Microsoft Edge, the In progress status will be shown
indefinitely for the following scenarios:
• When the бот fails to compile
• When the бот fails to deploy
• When the Bot Agent service stops or fails
• When the Bot Runner user is not assigned the Allow a

Бот user to update боты permission

Не применимо Да

Related concepts
Microsoft Internet Explorer EOL overview on page 770
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Microsoft has announced retiring Internet Explorer (IE) for certain versions of Windows operating systems
and recommends impacted users to move their apps or websites running on IE to Microsoft Edge with IE
mode.
Microsoft Internet Explorer EOL overview on page 770
Microsoft has announced retiring Internet Explorer (IE) for certain versions of Windows operating systems
and recommends impacted users to move their apps or websites running on IE to Microsoft Edge with IE
mode.
Related reference
Заметки о выпуске Automation 360 v.24R2 для прекращения поддержки Internet Explorer 11 on page
263
Related information
Enterprise 11 and upcoming Internet Explorer 11 EOL FAQ

Сканирование боты Automation 360 на предмет использования Internet
Explorer
Прекращение поддержки (EOL) Microsoft Internet Explorer состоится в июне 2022 года, и корпорация
Microsoft рекомендует переместить в Microsoft Edge в режиме IE устаревшие приложения и
веб-сайты, работающие в Internet Explorer. С помощью Bot Scanner Automation 360 для утилиты IE
просканируйте ваших боты Automation 360 на предмет использования Internet Explorer.
• Убедитесь, что пользователь вашего Control Room имеет разрешение Смотреть содержимое в

папке Bots.
• Проверьте соответствие указанным ниже системным требованиям для использования Bot Scanner.

• Требования к аппаратному обеспечению

Процессор 2,66 ГГц или больше (64-битный)

ОПЕРАТИВНАЯ ПАМЯТЬ 2 Гбайт или больше

Дисковое пространство 200 Мбайт

• Требования к программному обеспечению
Операционные системы: Windows 7 или более поздняя версия (32- или 64-разрядная
версия)

1. Перейдите в раздел A-People Downloads page (Login required).
2. Загрузите файл automation-360-bot-scanner-for-ie-1.0.zip из папки Automation 360

v.24 R2 (13343) > Installation Setup.
3. Extract the files from the zip file you have downloaded and double-click the executable file to run the

utility.
4. Щелкните Начать.
5. Введите Control Room URL-адрес Automation 360 (On-Premises или Cloud), к которому

собираетесь подключиться, и используйте репозиторий Боты, содержащий боты Internet
Explorer, которые хотите просканировать.

Note:  The Bot Scanner for IE utility does not support a proxy server. If you use a proxy to provide
the Control Room URL, you will not be able to establish the connection.
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6. В зависимости от типа проверки подлинности, настроенного в вашей Control Room, выберите
один из указанных ниже методов проверки подлинности в поле Тип проверки подлинности.
Тип проверки подлинности Шаги

База данных a. Введите Имя пользователя (имя
пользователя базы данных Control Room).

b. Введите Пароль (пароль пользователя
базы данных Control Room).

Active Directory (по умолчанию) a. Введите Имя пользователя (Domain\\
\username).

b. Введите Пароль (пароль пользователя
домена).

Единый вход a. Введите Имя пользователя.
b. Введите API-ключ.

7. Щелкните Проверить подключение.
Отображается сообщение об успешном или неудачном подключении. Если выполнить
подключение не удалось, повторно проверьте свои учетные данные.

8. В поле Выберите путь назначения введите местоположение, в котором хотите сохранить
созданный отчет.

9. Щелкните Сканировать ботов.
Сканер выполняет сканирование всех боты в репозитории Control Room на предмет
использования Internet Explorer. После завершения сканирования создается отчет (файл .CSV),
содержащий все сведения. Если файл .CSV уже существует в выходной папке, отобразится
сообщение о том, что старый файл .CSV будет удален, а после щелчка по Продолжить будет
создан новый файл .CSV. Если старый файл .CSV находится в использовании, отображается
сообщение о том, что файл не может быть удален. Закройте файл и повторите попытку.
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10. Щелкните Открыть отчет, чтобы проанализировать отчет, созданный сканером, для получения
статистики об использовании Internet Explorer в ваших боты.
Отчет содержит указанные ниже сведения.
• Имя TaskBot. Имя TaskBot
• Номер строки. Номер строки бот, в котором используется браузер Internet Explorer
• Имя Пакет и action. Имя пакет и action, в котором используется браузер Internet Explorer
• Искомый текст. Содержит заголовок окна или браузера
• Сообщение о действии и проверке. Содержит проверки или действия, необходимые

пользователю после преобразования
• Путь TaskBot. Путь к репозиторию, в котором находится бот

Note:  На основе отчета, созданного сканером, можно спланировать и реализовать стратегию
преобразования боты, которые используют Internet Explorer, для работы в Microsoft Edge в
режиме IE. С помощью отчета можно определить указанные ниже данные.
• Уникальные имена TaskBot, которые используют Internet Explorer
• action в каждом бот, который использует Internet Explorer
• Можно ли преобразовать action или нет
• Требуется ли проверка action после преобразования

See the following video on how to scan Automation 360 боты for Internet Explorer usage:

Bot Scanner не преобразует ваши боты, работающие в Internet Explorer, для работы в Microsoft Edge
в режиме IE. Для преобразования необходимо использовать мастер обновления ботов. См. раздел
Update Bot wizard for converting IE боты on page 791.

Analyze report for Internet Explorer боты
You can analyze the report generated by the Bot Scanner to get usage statistics about Internet Explorer
used in your боты.
Based on the report that Bot Scanner generates, you can plan and implement a strategy to convert боты
that use Internet Explorer to Microsoft Edge with IE mode.
Bot Scanner provides the following information about these боты:
• Количество проанализированных боты
• Number of боты scanned for Internet Explorer usage and those that were not scanned
• Internet Explorer usage statistics on the percentage and number of боты using Internet Explorer
• Reasons for боты that were not scanned
• Reviews required by users after conversion

The Bot Scanner is designed to scan боты (TaskBots and MetaBots) created using bothEnterprise 10 and
Enterprise 11 versions of Enterprise Client. Общее число файлов включает в себя файлы, которые
были пропущены и не просканированы.

Folder location and reports

Отчеты доступны в расположении вывода, которое вы указали в поле Выбрать целевую папку
в диалоговом окне Automation Anywhere Bot Scanner. Bot Scanner генерирует сводный отчет
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и отдельный отчет для каждого просканированного бот. Отдельный отчет создается для каждой
логики, доступной в MetaBot.
Для каждого просканированного бот создается папка raw-data, которая содержит
соответствующие отчеты (в формате XML). It helps our developers to further analyze the scanning
process and take corrective actions, if required. Никакая информация, позволяющая установить
личность (PII), не включается в сводный отчет или отдельные отчеты об отсканированных боты.
If you choose to share the reports with us to help improve the product, compress the files in the rawdata
folder and coordinate with your Customer Success Manager (CSM) or Partner Enablement Manager (PEM).
Никакие данные не передаются в Automation Anywhere автоматически.
The system creates three folders within the raw-data folder that contain various reports:
• Migratable_Bots. Contains reports of боты that are possibly using Internet Explorer.
• Failed_to_Analyze. Contains reports of боты that Bot Scanner failed to analyze.
• MetaBots. Contains reports of MetaBots that can and cannot be migrated to Automation 360 and the

ones that the Bot Scanner failed to analyze.

Сводный отчет по всем боты

The summary report provides information about the total number of боты scanned, the number of боты
scanned for Internet Explorer usage, the number боты that could not be scanned. It also provides Internet
Explorer usage statistics about the percentage and number of боты using Internet Explorer.
Например, Bot Scanner просканировал 31 боты. Of the 31 боты, consider 26 боты are scanned for
Internet Explorer usage, and 0 боты could not be scanned. The percentage of боты using Internet
Explorer is 84%.
Проверка отчета Bot Scanner
Consider a scenario where you have scanned a total of 72 боты, of which 22 боты are scanned for
Internet Explorer usage and 3 боты could not be scanned. In such a scenario, the report enables you to
perform the following actions:
• Identity боты (8) that require review after conversion and take action if required.
• Identify боты (14) that do not require any review after conversion.
• Identify the reason why the боты (3) cannot be currently scanned for Internet Explorer usage. The

reason might be that the бот is built using a version earlier to Enterprise 10 such as Enterprise 8.

На следующем изображении представлен пример отчета из Bot Scanner.
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В следующей таблице представлены различные поля в примере отчета Bot Scanner (в соответствии с
нумерацией на предыдущем изображении).

Поле/параметр Описание

• Bots scanned for IE usage > Review required > Bots: Go to this view for
a list of боты (8 in this scenario) that should be reviewed after conversion.

• Чтобы просмотреть сообщение о необходимости выполнения проверки
для определенного бот, щелкните по имени бот. The message provides
information about changes if any are required in the бот after conversion.

Bots scanned for IE usage > No review required > Bots: Go to this view for
a list of боты (14 in this scenario) that do not require any review after conversion.
Щелкните по имени любого бот в этом списке, чтобы просмотреть отчет в
формате XML в автономном режиме.
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Поле/параметр Описание

• Bots that can't be scanned now > Bots: Go to this view for a list of боты
(3 in this scenario) that cannot be currently scanned.

• Чтобы просмотреть сообщение об ошибке для определенного бот,
щелкните по имени бот. An XML report opens in a new tab where you can
view the error due to which the бот cannot be scanned.

Download (as a CSV file) the list of боты or commands that can or cannot be
scanned so that you can review the file offline or share the file with others.

Report validity

Отчет действителен до тех пор, пока не будет доступна следующая версия Bot Scanner. When the
next version is available, a report expiry message is displayed. You must download the latest version of Bot
Scanner and use that version to scan the боты again.

Update Bot wizard for converting IE боты
Use the Update Bot wizard to convert Internet Explorer боты created in Automation 360 to Microsoft Edge
with IE mode.
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• Ensure you are logged in as an administrator or have given the following permissions to the user
performing the бот update and to the Bot Runner you have selected:
• Users performing the бот update:

• View bot update
• Manage bot update
• View Users and Roles basic information
• View everyone's audit log actions
• View packages
• View my bots
• Run my bots
• You must have the below-mentioned permissions for Bots, Sample bots, and the folders

containing the боты you want to update:
• Run
• Check in
• Check out
• View content

• A role that has access to Bot Runner that you want to select for running the update (on the
Administration > Bot update > Bot Runners page)

• Bot Runner:
• Необслуживаемая лицензия Bot Runner
• Статус Автоматический вход задан
• Allow a bot-runner user to update bots
• Create folders
• View packages
• Register device
• View my bots
• Run my bots
• Below permissions for the folders containing the bots you want to update,

• Check in
• Check out

• Default device settings

For more information on creating users and roles, see Create a user on page 2699 and Create a role on
page 2708.

• The Internet Explorer боты should already be identified for conversion.
• The боты must be Checked in and available in the Public workspace.

Note:  You cannot use the Update Bot wizard to convert Enterprise 10 and Enterprise 11 боты created
using Internet Explorer. Подробнее см. в разделе Bot Migration Wizard on page 1223.

See the following video for an overview of the Bot update wizard:
1. Navigate to Administration > Bot update in the Control Room.

If you have not performed any бот updates previously, the Bot update list on the Bot update page
will not display бот updates.

2. Click Update bots to open the Update Bot wizard.
3. In the Settings tab, add details such as the name and description to update боты.
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4. Щелкните Вперед.
5. On the Bots tab, navigate to the Боты folder that contains the Internet Explorer боты.
6. Select боты from the list of available files and add the боты to the list of selected files.

You can choose from the latest or production version боты.

Note:  You do not have to select the dependent боты because the dependent боты are selected
automatically.

7. Щелкните Вперед.
8. Select Bot Runner devices from the list of Bot Runner to run the бот update.
9. Щелкните Вперед.
10. Verify details such as the бот type, name, version, and folder path on the Бот and Dependent Боты

tab.
11. Click Update bots.

The selected боты and dependent боты are deployed on the selected Bot Runner for conversion from
IE to Microsoft Edge with IE mode. The боты are converted one at a time and a new version of the
боты is uploaded to the Control Room public repository. A new entry for updated боты is created
during the бот conversion process on the Bot update list page.
The page shows the status and summary of the боты updated for conversion. You can refresh the
page to view the current бот conversion status.

A list of the different бот conversion status during the conversion process is as follows:
• In progress: Indicates that the бот conversion has started.
• Completed: Indicates that the бот conversion process is completed.
• Failed: Indicates that the conversion of one or more боты has failed.

12. Select View update bots details from the actions menu ( ) to view the бот conversion details of
each бот.
See Conversion report for IE bots.
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See the following video on how to run the Бот update wizard:

Related concepts
Бот permissions for a role on page 2722
Assign бот permissions when creating a role with the View my боты feature permission.
Related reference
Разрешения на использование для функции on page 2709
Пользователь с функцией AAE_Admin или пользовательской функцией с разрешением
Управление функциями может создавать и назначать функции пользователям для
предоставления им доступа к функциям и операциям.

Viewing conversion details for Internet Explorer боты
For each update бот action, you can view details about the overall summary and status of individual бот
conversion that is converted from Internet Explorer to Microsoft Edge with IE mode.

Viewing бот details

1. In the Control Room, go to Administration > Bot update.
2. Select an instance of the бот conversion from the list and click View update bot details action from

the action menu for that instance.
The Update details page opens with detailed information about the name of the instance and the
overall status of the бот conversion (at the top of the page). For more information, you can navigate
to different tabs on this page: Summary, Settings, Bot Runner, and Results.

Summary details

You can view the following details in the Summary tab:
• Start time: Indicates the time when the бот conversion started
• End time: Indicates the time when the бот conversion completed
• Duration: Total duration taken for бот conversion to complete
• Completed items: Total list of items that are converted with completed status
• Failed items: Total list of items that failed to convert
• Skipped items: Total list of skipped items during conversion based on appropriate reasons
• Details of the selected боты and dependencies, listed in a table

The data is listed by file name by default. You can search for specific боты and dependencies by file name.

Настройки

The Settings tab displays the following fields:
• Description: Displays any description you might have added before running the Update Bot wizard
• Update the боты built using Internet Explorer to Microsoft Edge Internet Explorer mode. By default, this

field is set to Yes
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Bot Runner

This tab displays the list of Bot Runner on which the бот conversion is done.

Результаты

View the status of individual бот conversion on this tab:
• Status: Status of the individual бот conversion (completed, skipped, failed)
• Type: Type of the бот, for example TaskBot
• File name: Имя бот
• Folder path: Path where the бот resides in the public workspace
• Bot Runner: The Bot Runner machine used to perform the бот conversion
• Reason: Reason why the бот conversion is in either failed, skipped, completed with review required, or

completed with action required status
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When you click the View Bot update for an individual бот status entry in this tab, the following reason
and action values for the боты are shown.

Статус Причина Действие

Ожидание - -

Выполнено - -

Пропущено The бот is not updated as it
does not use actions based on
Internet Explorer

-

Completed with Review
Required

The бот has some actions
updated that requires your
review

View бот update issues

Completed with Action Required The бот has some actions
updated that requires your
action

View бот update issues

Неудачно The бот uses some actions that
are not supported for update to
Microsoft Edge with IE mode

View бот update issues

The view бот update page displays the following columns:
• Номер строки
• Action name
• Reason for Recommendation

You can view the information listed in the reason column for the line number and open the corresponding
бот, go to the line number and review based on the information provided in the window or take action as
required.
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Deprecation of Basic authentication in Exchange Online
Microsoft will permanently disable Basic authentication for specific protocols in Exchange Online starting
from October 1, 2022. This impacts customers running бот for email automation that connect to Exchange
Online using IMAP, POP3, or EWS protocols with Basic authentication.

Important:  We have updated the Эл. почта package and Эл. почта trigger with newer versions as
mentioned below:

Package or trigger New version Old version

Пакет Эл. почта • Version:
3.14.3-20220923-220748

• Filename: bot-command-
email-3.14.3.jar

• Version:
3.14.1-20220831-084727

• Filename: bot-command-
email-3.14.1.jar
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Package or trigger New version Old version

Триггер Эл. почта • Version:
2.8.3-20220923-171042

• Filename: bot-trigger-
email-2.8.3.jar

• Version:
2.8.1-20220831-123116

• Filename: bot-trigger-
email-2.8.1.jar

We recommend that you update your impacted боты with the new versions as they are compatible
with the upcoming Automation 360 v.27 release. If you continue to use the old versions and update to
Automation 360 v.27 release, you might encounter issues when importing or exporting of боты or when
uploading the old versions of the Эл. почта package or trigger to Automation 360 v.27. To resolve this
issue, see the workaround provided in Everything about Basic Authentication deprecation in Microsoft Exchange
online (A-People login required).

We will provide a new version of the Эл. почта пакет with OAuth 2.0 support in an upcoming Automation
360 package-only release by the week of August 29, 2022.
To ensure that your existing боты that are using Basic authentication in Exchange Online are supported
after Basic authentication is deprecated, we recommend that you update the боты to use OAuth 2.0. To
identify the Automation 360 боты that are using Basic authentication in the Эл. почта пакет or Эл. почта
trigger, use the Bot Scanner to scan боты. This helps you to plan your efforts to update your existing боты
to OAuth 2.0 in Automation 360.
• Обзор Bot Scanner on page 1166
• Scan Automation 360 боты for Эл. почта action with Basic authentication usage on page 808

Update Automation 360 боты to use OAuth 2.0

1. Update to the latest Automation 360 release.

Обновление до последней версии Automation 360 on page 1070
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2. Back up the Control Room repository.
Integrating Control Room with Git repositories on page 2770

3. Identify боты that are using Basic authentication using the Bot Scanner.
Scan Automation 360 боты for Эл. почта action with Basic authentication usage on page 808

4. Download the latest version of the Эл. почта пакет and add it to your Control Room.
Add пакеты to the Control Room on page 2664

5. Update the боты that are using Basic authentication in the Connect, Send, Forward, or Reply
actions or Эл. почта trigger to use OAuth 2.0.
Update боты using Basic authentication to OAuth 2.0 on page 799

6. Verify that the updated боты can be deployed.
Run a бот on page 2007

Note:  You can update your боты to use OAuth 2.0 in one environment (for example, development or
DEV) and then move these боты to another environment (for example, UAT and production or PROD)
without updating the боты in each environment.

Protocols impacted for Basic authentication deprecation

Microsoft is removing the capability to use basic authentication in Exchange Online for these specific
protocols: MAPI, RPC, Offline Address Book (OAB), Exchange Web Services (EWS), POP, IMAP, Exchange
ActiveSync (EAS), and Remote PowerShell.

Note:  SMTP AUTH is excluded from this deprecation.

Any client (for example, user app, script, or integration) using Basic authentication for one of the affected
protocols will not be able to connect to Exchange server starting October 1, 2022. An HTTP 401 error (bad
username or password) will be displayed.

Note:  Any app using OAuth 2.0 for these same protocols will not be impacted.

Подробнее см. в разделе Basic authentication deprecation in Exchange Online – Updates.

Update боты using Basic authentication to OAuth 2.0

You should update your боты that are using Basic authentication to OAuth 2.0 in the Connect, Forward,
Reply, and Send actions of the Эл. почта пакет and Эл. почта trigger before Basic authentication is
deprecated.

Note:  This procedure is applicable to both Automation 360 Cloud and On-Premises customers.

Prerequisites
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• The Installation Setup folder in the Automation 360 v.25 Basic Authentication MS
 Online - Deprecation downloads folder contains the following JAR files:
• Эл. почта пакет (bot-command-email-3.14.1.jar)

Ensure that you download this пакет and add it to your Control Room in Automation 360.
• Эл. почта trigger (bot-trigger-email-2.8.1.jar)

Ensure that you download this package and add it to your Control Room in Automation 360
• Trigger listener (triggerlistener.jar)

If you are on Automation 360 v.25 release, ensure that you download and install the trigger listener
file. См. раздел Install the trigger listener file on page 802.

For information on adding пакеты to the Control Room, see Add пакеты to the Control Room on page
2664.
To download these JAR files, see Everything about Basic Authentication deprecation in Microsoft Exchange
online (A-People login required).

• Ensure that you have run the Bot Scanner utility for the deprecated features to identity the боты that
are using Basic authentication in your Control Room repository.
См. раздел Scan Automation 360 боты for Эл. почта action with Basic authentication usage on page 808.

• Ensure that you have registered your application on the Azure portal and performed the following
configurations for Client credentials flow:
• IMAP/POP3

1. Register an application

2. Authenticate an IMAP, POP or SMTP connection using OAuth

• EWS
1. Register an application

2. EWS OAuth authentication

3. Configure application access policy

Procedure
1. Log in to your Control Room as Bot Creator.
2. Select the бот that was identified in the Bot Scanner report for updating.
3. Check out the бот to edit it.
4. In the Бот editor, click the vertical ellipsis in the top right-corner and click Packages.
5. Expand the row for the Эл. почта пакет.
6. From the drop-down list of пакет versions, select the Default version.

Note:  For Эл. почта пакет, ensure that the пакет version is 3.14.1-20220831-084727 or later.
For Эл. почта trigger, ensure that the пакет version is 2.8.1-20220831-123116 or later.

7. Click Change Version and Save.
8. Click Return to editor.
9. Click the Эл. почта action or Эл. почта trigger that is using the Basic authentication mode.
10. Click the Email server or EWS server option.
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11. In the Authentication mode drop-down list, choose the required OAuth 2.0 mode.

Note:  For unattended Эл. почта automation, use Client credentials or ROPC flows, and for attended
Эл. почта automation, use Implicit or PKCE flows. Microsoft does not recommend the use of ROPC
and Implicit legacy flows. Therefore, we recommend that you either use the Client credentials or PKCE
flow.

The following table provides information about the OAuth 2.0 authentication modes that are available
for Эл. почта action in the Эл. почта server and EWS server options:

Действия Эл. почта Эл. почта server Сервер EWS

Подключить • OAuth2 – Authorization
code with PKCE

• OAuth2 – Client
credentials

• OAuth2 – ROPC
• OAuth2 – Implicit
• OAuth2 – Authorization

code with PKCE
• OAuth2 – Client

credentials

Отправить OAuth2 – Authorization code
with PKCE

• OAuth2 – ROPC
• OAuth2 – Implicit
• OAuth2 – Authorization

code with PKCE
• OAuth2 – Client

credentials

Переслать OAuth2 – Authorization code
with PKCE

--

Ответить OAuth2 – Authorization code
with PKCE

--

The following table provides information about the OAuth 2.0 authentication modes that are available
for Эл. почта trigger in the Эл. почта server and EWS server options:

Триггеры Эл. почта server Сервер EWS

Триггер Эл. почта OAuth2 – Client credentials OAuth2 – Client credentials

• OAuth2 – ROPC: Uses Resource Owner Password flow (Microsoft identity platform and OAuth 2.0
Resource Owner Password Credentials)

Note:  The existing Silent flow has been renamed to ROPC.

• OAuth2 – Implicit: Uses implicit grant flow (Microsoft identity platform and implicit grant flow)

Note:  The existing Interactive flow has been renamed to Implicit.

• OAuth2 – Authorization code with PKCE: Uses authorization code with PKCE grant flow
(Microsoft identity platform and OAuth 2.0 authorization code flow)

• OAuth2 – Client credentials: Uses client credentials flow (Microsoft identity platform and the OAuth
2.0 client credentials flow)
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12. Depending on the authentication mode that you selected, you might have to update some of the
following fields:
• Имя пользователя. Enter the username that you want to use to access the mail server.

Например, john.smith@myCompanyName.com
• Пароль. Enter the password for the username you provided.
• Email provider: Select the email provider from the drop-down list.

Note:  For Client ID, Tenant ID, Redirect URI, and Client secret options, use the information
that is provided for your account on your Azure portal.

См. Эл. почта пакет on page 1506 и Add an email trigger on page 2224.
13. For EWS server, click Test connection to sign in to your account, accept the permissions requested

to authenticate, and establish a connection with the server.

Note:  In the Microsoft Azure app registrations portal, in Manage > Authentication, ensure that
the URI you have added is either https://outlook.office365.com or https://outlook.office365.us for the
connection to work properly.

14. Щелкните Сохранить.

Repeat these steps for all the impacted боты and run the боты to ensure that they can connect to
Exchange Online using OAuth 2.0 successfully.

Install the trigger listener file

To use the Эл. почта trigger with OAuth 2.0, you have to update the triggerlistener.jar in the Bot
Agent.
1. In the Windows Task Manager, stop the Automation Anywhere Bot Agent service.
2. Go to the folder where the Bot Agent is installed (C:\Program Files\Automation Anywhere

\Bot Agent).
3. Locate the triggerlistener.jar file and rename the file to triggerlistener.jar_old.
4. Copy the downloaded triggerlistener.jar.
5. In the Windows Task Manager, start the Automation Anywhere Bot Agent service.

Другие ресурсы

• Automation 360 and Basic authentication deprecation FAQ on page 803
• Scan Automation 360 боты for Эл. почта action with Basic authentication usage on page 808
• Everything about Basic Authentication deprecation in Microsoft Exchange online (A-People login required)
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Automation 360 and Basic authentication deprecation FAQ
Microsoft has announced EOL for Basic authentication that is used to connect to Exchange Online. This will
impact automations (боты) using Эл. почта пакет or Email trigger that uses Basic authentication. Review
the FAQ for details about the deprecation of Basic authentication.

What is Basic authentication deprecation? Microsoft has announced that starting October 1,
2022, Basic authentication will be permanently
turned off (disabled) for specific protocols in
Exchange Online for MAPI, RPC, Offline Address
Book (OAB), Exchange Web Services (EWS), POP,
IMAP, Exchange ActiveSync (EAS), and Remote
PowerShell.
Exclusion: SMTP AUTH is excluded from this
deprecation for tenants which are already using it
Any client (user app, script, integration, and so
on) using Basic authentication for one of the
affected protocols will be unable to connect after
that specified date. The app will display an HTTP
401 error: bad username or password. Any
app using OAuth 2.0 for these protocols will be
unaffected.
Basic authentication in Exchange Online

What is Microsoft's recommendation to
mitigate Basic authentication deprecation?

Per Microsoft's recommendation, you are requested
to switch from Basic authentication to OAuth 2.0 if
your clients or apps are using Basic authentication
with any of the affected protocols to connect to
Exchange server via Exchange Online.

Note:  The Basic authentication deprecation applies
to Exchange Online only and not to Exchange on-
premises version.

Зачем нужно это изменение? Basic authentication is an outdated industry
standard, less secure, and poses high risks to
accessing customers' sensitive data. The latest
industry standard is OAuth 2.0 which is more secure
and less vulnerable to cyber attacks.

What if I am not ready for this change? If you are not ready to switch to OAuth 2.0 by
October 1, 2022, Microsoft has provided a one-
time re-enablement option that will allow you to
continue to use Basic authentication for specific
protocols until end of December 2022. Per the
Microsoft announcement, customers will be able
to use the self-service diagnostic to re-enable
Basic authentication for any protocols they need,
once per protocol. After the diagnostic is run, Basic
authentication will be re-enabled for the specified
protocols and will stay enabled until the end of
December 2022.
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Note:  During the first week of calendar year 2023,
the specified protocols will be disabled for Basic
authentication use permanently.

Basic Authentication Deprecation in Exchange Online –
September 2022 Update

Where is Basic authentication used in
Automation 360 product?

In Automation 360, the Basic authentication feature
is available in the Connect, Send, Forward, and
Reply actions of the Эл. почта пакет and in Эл.
почта trigger where you configure connection
parameters using any of the IMAP, POP3, SMTP, or
EWS protocols.

How do I know if I am going to be impacted
by Basic authentication deprecation?

Basic authentication deprecation will impact you for
the following cases:
• If you are automating email using Эл. почта

пакет or Эл. почта trigger
• If you are using Basic authentication to connect

to Exchange Online
• If you are using the IMAP, POP3, or EWS

protocol

When Basic authentication will be disabled by
Microsoft starting October 1, 2022, then all the
Automation 360 боты for Эл. почта automation
that meets the previously mentioned criteria will fail
because the бот cannot connect to the Эл. почта
server.

Когда прекратится поддержка? Basic authentication will be disabled by Microsoft
starting October 1, 2022.

How can I identify Automation 360 боты
in my repository that are using Basic
authentication with Эл. почта пакет or Эл.
почта trigger?

For Automation 360 боты, you can run the Bot
Scanner utility for EOL features.
Scan Automation 360 боты for Эл. почта action with
Basic authentication usage on page 808
• The scanner will scan all the боты that are using

Basic authentication with Эл. почта пакет or Эл.
почта trigger and having IMAP, POP3, or EWS
protocols.

• The scanner will then generate a CSV output
listing all the impacted боты, including the
specific line numbers and the specific actions to
be performed.

Which feature will be provided in
Automation 360 to mitigate the risk of Basic
authentication deprecation?

The OAuth 2.0 feature will be available in
Automation 360 in the Эл. почта пакет for the
Connect, Send, Forward, and Reply actions
and Эл. почта trigger for IMAP, POP3, and EWS
protocols so that you can use this feature to switch
from Basic authentication to OAuth 2.0.
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What is the schedule and release version
for introducing the OAuth 2.0 feature in
Automation 360?

The OAuth 2.0 feature will be delivered as a пакет
only release in the week of August 29, 2022. This
release will include the following:
• Bot Scanner utility
• Updated versions of Эл. почта пакет, Эл. почта

trigger, and trigger listener

Where can I download the Эл. почта пакет? You can download the Эл. почта пакет from the
link in the following article: Everything about Basic
Authentication deprecation in Microsoft Exchange online
(A-People login required).

Is the OAuth 2.0 feature backward-
compatible with any of the previous releases
of Automation 360?

No. The OAuth 2.0 feature is not backward-
compatible with previous Automation 360 releases.
Therefore, you are requested to manually update
the пакет released with Automation 360 v.25.

What are the steps involved to update my
impacted боты to switch to OAuth 2.0?

See to the following documentation page for the
steps to update your impacted боты and switching
from Basic authentication to OAuth 2.0: Deprecation
of Basic authentication in Exchange Online on page
797.

What are the different grant types or flows
supported for OAuth 2.0 in Automation 360?

In Automation 360, there are two primary grant
types that are supported for OAuth 2.0 across Эл.
почта пакет and Эл. почта trigger:
• Client credentials: Эл. почта пакет and Эл.

почта trigger
• Authorization code with PKCE: Эл. почта пакет

Within Эл. почта пакет, the individual Connect,
Send, Forward, and Reply actions support each
of these grant types as listed in the following table:

Action name Эл. почта
Server option

EWS option

Client
credentials

Client
credentials

Authorization
code with
PKCE

Authorization
code with
PKCE

— ROPC or Silent

Email >
Connect

— Implicit or
Interactive

— Client
credentials

Authorization
code with
PKCE

Authorization
code with
PKCE

Email > Send

— ROPC or Silent
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Action name Эл. почта
Server option

EWS option

— Implicit or
Interactive

Email >
Forward

Authorization
code with
PKCE

—

Email >
Reply

Authorization
code with
PKCE

—

Email Trigger Client
credentials

Client
credentials

Note:
• The existing Silent flow has been renamed as

ROPC (Resource Owner Password Credentials)
and the existing Interactive flow has been
renamed to Implicit.

• Both ROPC and Implicit grant flows are legacy
flows, less secure, and are not recommended by
Microsoft.

• The Client credentials flow for SMTP protocol is
currently not supported by Microsoft to access
Exchange Online.

• OAuth grant types
• Authentication flow support in MSAL
• OAuth 2.0 Client Credentials Flow support for POP

and IMAP protocols in Exchange Online

What will happen to my existing боты that
use email automation when I update to the
Automation 360 v.25 to update the default
version of the Эл. почта пакет or Эл. почта
trigger to the latest version?

When you update to the latest version of the Эл.
почта пакет or Эл. почта trigger, the existing боты
that use email automation will include the following
changes:
• If your боты are using the Email server

option with IMAP or POP3 protocol, the
Authentication mode option will be set to
Basic by default to indicate that the action uses
Basic authentication.
If the Host field in the Email server option
uses a variable, the Authentication mode
option will be set to Basic.

• If your боты are using the EWS server option
with the Authentication mode option set to
Basic, there is no change in the боты.

Note:  This is the default scenario when you
update the Эл. почта пакет.
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• If your боты are using the EWS server option
with the Authentication mode option set to
OAuth2-Silent, the Authentication mode
option will be set to OAuth2 - ROPC to indicate
that the action uses the ROPC grant flow.

• If your боты are using the EWS server option
with the Authentication mode option set to
OAuth2-Interactive, the Authentication
mode option will be set to OAuth2 - Implicit
to indicate that the action uses the implicit grant
flow.

Why is the Отправить сообщение эл. почты
action marked as Deprecated in my existing
боты?

When you update your боты with the latest version
of the Эл. почта package, you will notice that the
Отправить сообщение эл. почты action used in
your боты are marked as Deprecated due to the
following reasons:
• We have created a new version of the

Отправить сообщение эл. почты action
which provides support for OAuth 2.0 mode of
authentication.

• The new Отправить сообщение эл. почты
action is available in the Эл. почта package
version 3.14.1-20220831-084727 or later.

• The Deprecated message will help you
differentiate the old Отправить сообщение
эл. почты action from the new Отправить
сообщение эл. почты action.

Note:  The Отправить сообщение эл. почты
action that is marked as Deprecated will continue
to work the same way as earlier without any
changes. However, if you want to switch from Basic
authentication to OAuth 2.0, you must replace
the deprecated Отправить сообщение эл. почты
action with the new Отправить сообщение эл.
почты action and configure the required OAuth 2.0
parameters.

Will Automation Anywhere provide any tool
for Automation 360 customers to update
their боты from Basic authentication to
OAuth 2.0?

No. You will have to manually update your impacted
боты to switch to OAuth 2.0.

What is the guidance for Enterprise 11
customers if their боты are impacted by Basic
authentication deprecation?

Enterprise 11 customers are recommended to
migrate their Эл. почта automation боты to
Automation 360 and leverage the OAuth 2.0
support. After migration, you can perform the
following:
• Upload the new version of the Эл. почта пакет

or Эл. почта trigger to Automation 360.
• Edit the impacted боты and set the latest

version of Эл. почта пакет or Эл. почта trigger
as default.
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• Manually update your боты by switching from
Basic authentication to OAuth 2.0.

Note:  This guidance is applicable to both Cloud
and On-Premises customers who are migrating to
Automation 360.

Are there any limitations when you update
the Эл. почта пакет?

We recommend that you do not perform a bulk
update of боты to change Basic authentication to
OAuth 2.0. You must manually edit the боты and
update to OAuth 2.0.
Deprecation of Basic authentication in Exchange Online
on page 797

Scan Automation 360 боты for Эл. почта action with Basic authentication
usage
Automatically identify Automation 360 боты that are using Basic authentication mode in the Connect,
Send, Forward, and Reply actions in the Эл. почта пакет and Email trigger, which are using IMAP, POP3,
or EWS protocols.
• Ensure that the user credentials used to connect to the Control Room has the View content

permission on the Bots folder.
The Bot Scanner utility connects to your Control Room using these credentials.

• Ensure that you meet the software and hardware requirements for using the Bot Scanner.
См. раздел Scan Enterprise 11 or 10 боты using Bot Scanner on page 1168.

1. Download the Bot Scanner utility using the link provided in the following article: Everything about Basic
Authentication deprecation in Microsoft Exchange online (A-People login required).

2. Extract the files from the zip file that you have downloaded and double-click the
Automation_360_Bot_Scanner_For_EOL_Features.exe executable file to run the utility.
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3. In the Bot Scanner page, ensure that the Bots using Email action with Basic authentication
option is selected from the drop-down list, and then click Continue.

4. In the Automation 360 Bot Scanner EOL features page, perform these steps:
a) Enter the Control Room URL that you want to connect to
b) В зависимости от типа проверки подлинности, настроенного в вашей Control Room,

выберите один из указанных ниже методов проверки подлинности в поле Тип проверки
подлинности.

Тип проверки
подлинности

Шаги

Active Directory 1. Введите Имя пользователя (Domain\\
\username).

2. Введите Пароль (пароль пользователя домена).

База данных 1. Введите Имя пользователя (имя пользователя
базы данных Control Room).

2. Введите Пароль (пароль пользователя базы
данных Control Room).
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Тип проверки
подлинности

Шаги

Единый вход 1. Введите Имя пользователя.
2. Введите API-ключ.

c) Щелкните Проверить подключение.
Отображается сообщение об успешном или неудачном подключении. Validate your
credentials if the connection fails.

d) В поле Выберите путь назначения введите местоположение, в котором хотите сохранить
созданный отчет.

e) Щелкните Сканировать ботов.

The scanner scans all the боты in your Control Room repository for Basic authentication mode usage
in the Connect, Send, Forward, and Reply actions in the Эл. почта package and Эл. почта trigger.
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After the scan is complete, a report (.CSV file) is available in the destination path you selected for your
review.
• If a .CSV file already exists in the output folder, a message is displayed that the previous .CSV file

will be deleted. When you click Continue, a new .CSV file is generated.
• If the previous .CSV file is in use, a message is displayed that the file cannot be deleted. Close the

file and click Scan bots.

5. Click Open report to analyze the report.
Отчет содержит указанные ниже сведения.
• Имя TaskBot. Name of the TaskBot.
• Номер строки. The line number of the Connect, Send, Forward, or Reply actions that are using

Basic authentication.
For Email trigger, the line number will be empty.

• Имя Пакет и action. The Эл. почта package and action that is using Basic authentication.
• Искомый текст. The hostname of the Эл. почта server or the domain name of the EWS server for

the respective action.
• Сообщение о действии и проверке. Use this information to understand the action that you have

to perform or the information that you have to review for the corresponding action containing Basic
authentication.
См. раздел Basic authentication scanning messages on page 811.

• Путь TaskBot. The path to the repository where the бот resides.

After you identify the боты that are impacted due to Basic authentication, you can plan to update these
боты in the Control Room repository to switch to OAuth 2.0 authentication. For more information on how
to switch to OAuth 2.0, see Deprecation of Basic authentication in Exchange Online on page 797.

Basic authentication scanning messages
The Bot Scanner report might display some messages for your review or action for updating боты that are
using Basic authentication to OAuth 2.0 in the Эл. почта package or Эл. почта trigger. Messages provide
detailed information about the action, error, or review required to update the боты.

Код: A1001

Сообщение The Basic authentication mode that is used to connect to the
email server is deprecated by Microsoft.

For the bot to run, update the authentication mode by
selecting OAuth 2.0 and configuring the required parameters.
Otherwise, a connection error will occur.

Код: A1002

Сообщение The Basic authentication mode that is used to connect to the
EWS server is deprecated by Microsoft.

For the bot to run, update the authentication mode by
selecting OAuth 2.0 and configuring the required parameters.
Otherwise, a connection error will occur.
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Код: R1004

Сообщение A variable is used in the 'Host' property of this bot.
If the variable is pointing to 'office365.com', this can
potentially have an impact on the action since the Basic
authentication mode that is used to connect to the email
server is deprecated by Microsoft.

You are advised to review the variable and update the
authentication mode by selecting OAuth 2.0 and configuring
the required parameters.

Chrome and Edge Manifest V3 extensions
As Google will deprecate Manifest V2 extensions , this might impact your existing automations that use
the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers. We have published
Manifest V3 extensions with the Automation 360 v.26 release to help you start switching to Manifest V3
extensions.

Manifest V2 based deprecation

A manifest is a specification that is used to build browser extensions. As Google is deprecating Manifest
V2 based extensions, we recommend that you update to Manifest V3 based extensions, which provides an
enhanced security, privacy, and performance.
Impact to our customers: Automations that use Google Chrome Manifest V2 based extensions will
stop working sometime after June 2023. The deprecation timelines of Manifest V2 based extensions are
currently under review and subject to change by Google.
• For Google Chrome Manifest V2 extensions timelines, see Manifest V2 support timeline.
• For Microsoft Edge Manifest V2 extensions timelines, see Overview and timelines for migrating to Manifest

V3.

Post the given date, you must switch to Manifest V3 extensions for your automations to work. You can
choose to use the enterprise group policy for both Google Chrome and Microsoft Edge to continue to use
Manifest V2 based extensions. For more information on Manifest extensions support and timelines, see,
Manifest V3 transition timeline.

Automation 360 features that use browser extensions

The following Automation 360 features use the Google Chrome or Microsoft Edge browser extension for
web applications running on Google Chrome or Microsoft Edge:
• Bot Agent device registration with the Control Room (uses Chrome extension only)
• Automation of web applications through Universal Recorder or Браузер пакет
• User interface based triggers
• Пакеты that use window titles, for example, OCR and Mouse Click
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Plan the switch to Manifest V3 extensions

Note:  Manifest V3 extension is supported on Google Chrome and Microsoft Edge browsers version 91 and
later only.

Automation 360 customers: We have published new Google Chrome and
Microsoft Edge Manifest V3 extensions with the
Automation 360 v.26 release. We will also continue
to support Manifest V2 extensions until June
2023 to provide you time to switch to Manifest V3
extensions before Jan 2024 for Google Chrome. To
know about Microsoft Edge Manifest V2 extensions
timelines, see Overview and timelines for migrating to
Manifest V3.
You have the following options to switch to Manifest
V3 extensions:
• New customers: Users starting with

Automation 360 v.26 will directly use Manifest
V3 extensions. You will not be impacted by the
deprecation of Manifest V2 extensions.

• Cloud customers: Our Cloud deployments is
updated to Automation 360 v.26 in October, and
customers can switch to Manifest V3 extensions
when they update their Bot Agent.

• On-Premises customers:
• Updating to v.26: Customers updating from

an earlier version to Automation 360 v.26 will
switch to Manifest V3 extensions when they
update their Bot Agent.

• v.25: We have provided a Control Room
patch with Automation 360 v.25. After
installing the patch, the V2 extensions is
switched to Manifest V3 extensions when you
update the Bot Agent.

• v.24, v.23, and v.22: For customers on
Automation 360 v.24 or earlier, we strongly
recommend that you update to Automation
360 v.26 or later releases. If you choose not
to update, we will provide a set of steps to
perform on all Bot Agent and Bot Runner
devices to switch to Manifest V3 extensions.
См. раздел Manifest extension manual upgrade.

• v.21 and earlier: We strongly recommend
that you update to the latest version of
Automation 360.

Note:  You can choose to delay switching
to MV3 extensions by using a Chrome group
policy that extends support for Manifest
V2 extensions until Jan 2024  for Google
Chrome, see Manifest V3 transition timeline.
To know about Microsoft Edge Manifest
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V2 extensions timelines, see Overview and
timelines for migrating to Manifest V3.

Customers migrating to Automation 360 We recommend that you migrate to Automation 360
v.26, which uses Manifest V3 extensions by default.
If you are migrating to Automation 360 v.25,
install the Control Room patch, that we released in
October.

Enterprise 11 customers Подробнее см. в разделе Enterprise 11: Deprecation
of Basic authentication and MV2 extensions.

Extend Manifest V2 extensions usage through group policy

You can choose to use the enterprise group policy for both Google Chrome and Microsoft Edge to continue
to use Manifest V2 extensions till Jan 2024.
For information about Manifest V2 extension timelines for Google Chrome, see Manifest V3 transition
timeline. For Microsoft Edge, see Overview and timelines for migrating to Manifest V3.
You can extend the Manifest V2 deprecation only using the group policy. This extension provides you
adequate time to plan upgrading to Manifest V3 extensions. You can use any extension group policy to
extend the use of Manifest V2 extensions.
To update the policy, perform these steps:
1. Copy the following entries to a .txt file and save the file as a .reg file.

• Chrome:

Windows Registry Editor Version 5.00
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Google\Chrome
\ExtensionInstallForcelist]
"ExtensionSettings"="{\"kammdlphdfejlopponbapgpbgakimokm\":
{\"installation_mode\": \"normal_installed\",\"update_url\": \"http://
clients2.google.com/service/update2/crx\"}}"

• Edge:

Windows Registry Editor Version 5.00
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge
\ExtensionInstallForcelist]
"ExtensionSettings"="{\"dbmodiepejcigljbmeebedkmegndokbk\":
{\"installation_mode\": \"normal_installed\",\"update_url\": \"https://
edge.microsoft.com/extensionwebstorebase/v1/crx\"}}"

2. Run the .reg file.
3. Restart the browser for the changes to take effect.

Related concepts
Manifest V3 extensions FAQ on page 815
As Google will deprecate Manifest V2 extensions by June 2023, this might impact your existing automation
that use the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers.
Manually upgrade from Manifest V2 to V3 extensions for Chrome and Edge
Feature deprecations affecting Automation Anywhere products on page 763
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Review the features and capabilities (from Automation Anywhere or third party) that are deprecated or
nearing deprecation to understand how they affect your automation and what action is required.
Related tasks
Switch Manifest V3 to Manifest V2 extension manually on page 824
If you want to switch from Manifest V3 extension to Manifest V2 extension while remaining on Automation
360 v.26, you can manually switch to v2 extension.
Manage multiple browser profiles for Manifest V3 extension on page 822
Automation 360 v.26 automatically includes Manifest V3 extensions to support browser-based automation.
However, these V3 extensions in v.26 are by default for a single browser profile only.

Manifest V3 extensions FAQ
As Google will deprecate Manifest V2 extensions by June 2023, this might impact your existing automation
that use the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers.
We have published Manifest V3 extensions with the Automation 360 v.26 release to help you start
switching to Manifest V3 extensions.

What is Manifest V2 extension deprecation? A manifest is a specification using which browser
extensions are built. Google is deprecating Manifest
V2 extensions by June 2023 for Google Chrome.
To know about Microsoft Edge Manifest V2
extensions timelines, see Overview and timelines
for migrating to Manifest V3. The deprecation might
impact your existing automations that use Manifest
V2 extensions for Google Chrome and Microsoft
Edge browsers. So, we recommend that you plan
to switch to Manifest V3 extensions, which provide
enhanced security, privacy, and performance.
See the following resources for information on
Manifest V2 extensions deprecation timelines: :
• Google Chrome: Manifest V2 support timeline
• Microsoft Edge: Overview and timelines for

migrating to Manifest V3

When will the Manifest V2 support end? In June 2023, Manifest V2 extensions for Google
Chrome will stop functioning. You can update the
group policy for both Google Chrome and Microsoft
Edge to extend the use of Manifest V2 extensions
until Jan 2024 . For Microsoft Edge Manifest V2
extension timelines, see Overview and timelines for
migrating to Manifest V3 for more information.
Support for Manifest V2 for Google Chromeends in
Jan 2024 (see Manifest V3 transition timeline). To
know about Microsoft Edge Manifest V2 extensions
timelines, see Overview and timelines for migrating
to Manifest V3.You must switch to Manifest V3
based Google Chrome and Microsoft Edge browser
extensions by then.
To extend support for Manifest V2, see Extend
Manifest V2 extensions usage through group policy on
page 814.
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How do I know if I am going to be impacted
by the deprecation?

If you are using any or all of the following features
on Google Chrome or Microsoft Edge browsers, you
will be impacted by the Manifest V2 deprecation.
• Automation of web applications through

Universal Recorder or Браузер package
• User interface based triggers
• Bot Agent device registration with the Control

Room
• Packages that use Браузер variables, for

example, Средство записи, Распознавание
текста (OCR) and Mouse Click

Do I have to do anything in advance of the
deprecation?

To avoid being affected by the deprecation, you can
choose one of the following options:
• Upgrade to Automation 360 v.26, which includes

the latest Manifest V3 extensions.
• Switch to Manifest V3 extensions before June

2023  if you are using Google Chrome. For
Microsoft Edge Manifest V2 extensions timelines,
see Overview and timelines for migrating to Manifest
V3. .

• Update the group policy to extend support for
Manifest V2 extensions.
См. раздел Extend Manifest V2 extensions usage
through group policy on page 814.

What should I do to extend the group policy
to continue using Manifest V2 extensions?

You can use the group policy for both Google
Chrome and Microsoft Edge browsers to extend
support for Manifest V2 extensions. For more
information, see the following articles:
• Extend Manifest V2 extensions usage through group

policy on page 814
• Manifest V3 transition timeline
• Overview and timelines for migrating to Manifest V3

Will the Manifest V2 extensions be
automatically updated to V3 or do I have to
manually add V3 extensions to the browser?

• If you are on Automation 360 v.26 or later, and
if you have updated to Bot Agent 21.222 or later,
you will be automatically updated to Manifest
V3.

• If you are on Automation 360 v.25 and earlier,
you must manually upgrade the Manifest V2
to V3. См. раздел Manifest extension manual
upgrade. .

Which Automation 360 versions are certified
for upgrading from Manifest V2 to V3
extensions?

The following versions are certified for the upgrade:
• v.25
• v.24
• v.23
• v.22
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I plan to continue with Automation 360 v.25,
so what should I do to continue using MV2
extensions?

You can continue to use Manifest V2 extension only
till Jan 2024  for Google Chrome (see Manifest V3
transition timeline). To know about Microsoft Edge
Manifest V2 extensions timelines, see Overview and
timelines for migrating to Manifest V3. You will have to
perform manual steps to extend the support.
Подробнее см. в разделе Extend Manifest V2
extensions usage through group policy on page 814.

What about the automations that I have
already built using Chrome or Edge?

If your automations are dependent on browser
extensions, you must either upgrade to Manifest
V3 extensions or extend support for Manifest
V2 extensions for your automations to continue
working after the deprecation.

Do I need to update the Средство записи
пакет in the боты or will they continue to
work with the earlier versions?

The Средство записи пакет will work as intended,
so there is no need to update the package.

I am using Automation 360 Cloud, so will my
automations be impacted by the deprecation?

Cloud deployments are automatically updated to
the Automation 360 v.26 release, which includes
Manifest V3 extensions. The Bot Agent in v.26
refers to Manifest V3 extensions.

Note:  If the Automatically update all bot
agents option in your Control Room settings
is disabled on your device, you will not be
automatically updated to Manifest V3 extensions.
So ensure that this option is enabled to receive
automatic updates. Alternatively, you have to install
the Bot Agent manually on all the Bot Runner
devices.

How does the deprecation impact my
migration?

We recommend that you migrate to Automation 360
v.26, which uses Manifest V3 extensions by default.
If you are using Automation 360 v.25 or earlier, you
must either upgrade to Manifest V3 extensions or
extend Manifest V2 extensions before you migrate
browser-based automations.

Will the URL for the extensions change? Will
the URLs that I have added in the trusted list
for proxy settings be impacted?

Yes, the URLs for the extensions are different for
Manifest V2 and V3. Use the following URLs for
Manifest V3:
• Chrome: Google Chrome extension for Automation

360
• Edge: Microsoft Edge extension for Automation 360

Will Manifest V2 extensions be retained after
I upgrade to Manifest V3?

Until Jan 2024, you can continue to use the
extensions  for Google Chrome. To know about
Microsoft Edge Manifest V2 extensions timelines,
see Overview and timelines for migrating to Manifest
V3. However, these extensions cannot be modified
after December 2022, so Automation Anywhere
will not be able to make any updates to these
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extensions after December 2023. Also see, Manifest
V3 transition timeline.

Note:  If you are on Automation 360 v.26 release
and using Bot Agent 21.222, you will see both
Manifest V2 and Manifest V3 registry entries in the
Windows Registry.
• You can remove the Manifest V2 entry from

Windows Registry by uninstalling the existing
Bot Agent 21.222 and installing the Bot Agent
21.222 again.

• You can remove the Manifest V2 extension from
the Extensions page.

Uninstalling the Bot Agent will remove both
Manifest V2 and Manifest V3 extensions.
Uninstall or remove apps and programs in Windows

If Enterprise 11 and Automation 360 are
running on the same device , will there
be any conflicts due to the Manifest V2
deprecation?

There will be no impact in such scenarios because
the Manifest V3 extensions IDs are different for
Enterprise 11 and Automation 360.

As I am currently on Cloud deployment,
I'd prefer to continue using Manifest V2
extensions. Can I continue to use Manifest
V2?

We recommend that you upgrade to the latest
Automation 360 version to get the benefits of
Manifest V3 extensions. However, if you still want
to continue using Manifest V2 based extensions,
ensure that you disable the Automatically
update all bot agents option (in the Control
Room settings) for all devices and ensure that
users do not install the latest Bot Agent. This is
required because the Automation 360 v.26 Bot
Agent supports only Manifest V3 extensions.

Do I have an option to upgrade my devices in
a phased or staggered manner?

Yes, you can upgrade your devices in a staggered
manner to Manifest V3. You can disable the
Automatically update all bot agents option for
all devices and then select the devices individually
for which you want to upgrade the Bot Agent.

Can I continue to use Manifest V2 extensions
with the latest version of Automation 360?

Manifest V2 extensions are updated to Manifest
V3 extensions when you update Bot Agent to the
corresponding version of Automation 360 v.27.
Any existing configurations in the Manifest V2
extensions are overwritten.
Starting from Automation 360 v.26, Manifest
V3 extensions are bundled with the Bot Agent
installation. Therefore, Manifest V3 extensions
are installed when you update the Bot Agent. To
continue using the Manifest V2 extensions:
• Ensure that you do not update the Bot Agent.
• Select Disable auto updates option in Control

Room before updating your existing Automation
360 version.

© 2023 Automation Anywhere. All rights reserved.     818

https://developer.chrome.com/blog/more-mv2-transition/
https://developer.chrome.com/blog/more-mv2-transition/
https://support.microsoft.com/en-us/windows/uninstall-or-remove-apps-and-programs-in-windows-4b55f974-2cc6-2d2b-d092-5905080eaf98


    Automation Anywhere - Learn

См. раздел Автоматическое обновление Bot Agent
on page 1049.

Can I revert the upgrade from Manifest V3 to
V2?

Yes, you can switch from Manifest V3 to V2. Update
the JSON file with following Manifest V2 extension
IDs:
• Chrome V2 Extension ID:

kammdlphdfejlopponbapgpbgakimokm
• Edge V2 Extension ID:

dbmodiepejcigljbmeebedkmegndokbk

Подробнее см. в разделе Switch Manifest V3 to
Manifest V2 extension manually on page 824.

I had switched from Manifest V3 to V2
extensions for Automation 360 v.26. Can I
now update to Manifest V3 extensions when I
update Automation 360 to v.27?

When you update to Automation 360 v.27, the
corresponding Bot Agent is also updated. Manifest
V3 extensions are installed with the latest version of
Bot Agent.
Additionally, ensure that you select Enable
Automation 360 extension for this browser
profile option on Google Chrome and Microsoft
Edge browsers. См. раздел Manage multiple browser
profiles for Manifest V3 extension on page 822.

Note:  If you are currently using Manifest V2
extensions or earlier versions, we recommend that
you update and use the Manifest V3 extension.

My бот uses a Средство записи пакет from
an earlier Automation 360 version and has
a hard-coded Manifest V2 extension ID in it.
How do I change the extension ID?

When you update to Automation 360 v.26,
the extension ID for Manifest V3 is updated
automatically.

My application has IFrame with Content
Security Policy enabled. Will the Run
JavaScript action run the JavaScript inside
the IFrame?

With Manifest V3, Google has restricted access
to IFrame where Content Security Policy (CSP) is
enabled in target page. If your business application
does not have CSP enabled, you will be able to
run JavaScript inside the IFrame. If your business
application has CSP enabled, you will not be able
to run JavaScript inside the IFrame and the Run
JavaScript action will timeout or fail.

What version of the browsers are supported
for Manifest V3?

Manifest V3 is supported on Google Chrome and
Microsoft Edge Version 91 and later.

I am currently on Automation 360 v.26. Can I
switch to Manifest V2 extension?

Yes, you can switch to Manifest V2 extension while
being on Automation 360 v.26. Подробнее см. в
разделе Switch Manifest V3 to Manifest V2 extension
manually on page 824.

I am currently on Automation 360 v.26. Are
there any settings that I have to configure to
continue to avail the latest browser extension
versions?

If you have an internet connection, you will
continue to receive the updates through automatic
updates.

Can I use MV3 extension offline or without
internet connection?

MV3 extensions are automatically installed when
you update the Bot Agent to the latest version. MV3
based offline extensions are available for:
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• Google Chrome from Automation 360 v.26.
См. раздел Install Chrome Plugin offline or without
internet access in Automation 360.

• Microsoft Edge from Automation 360 v.27.

For additional help, contact Automation Anywhere
support.

Will there be any impact to the remote agent
that I have been using?

The remote agent installed with Automation
360 v.25 or earlier is not compatible with the
Manifest V3 extension. You must install the latest
Automation Anywhere remote agent and use the
latest Средство записи package.
См. раздел Install Automation Anywhere remote agent
for Citrix 2.0: Средство записи пакет version 2.8.6
on page 888.

What are the prerequisites to configure the
browser extension settings?

Following are the prerequisites to configure the
browser extension settings:
• Bot Agent version 21.222 or later.
• You must have installed the Bot Agent with

installation type as system-wide.

How to remove the Manifest V3 group policy? For Google Chrome: Navigate to
[HKEY_LOCAL_MACHINE\SOFTWARE
\Policies\Google\Chrome
\ExtensionInstallForcelist]
and remove the entries that contain
bboccnojhhoegfffpcllbeigipedjedf as the
extension ID.
For Microsoft Edge: Navigate to
[HKEY_LOCAL_MACHINE\SOFTWARE
\Policies\Microsoft\Edge
\ExtensionInstallForcelist]
and remove the entries that contain
fnmjcdajlonpigpcfnemeikipmolbfii as the
extension ID.
Restart the browser for the changes to take effect.

After updating to Automation 360 v.26, do I
have to disable Manifest V2 extensions?

When you upgrade to Automation 360 v.26,
Manifest V3 extensions is installed automatically,
without impacting the already installed Manifest V2
extensions. Both Manifest V2 and V3 extensions
can co-exist. The Manifest V2 extension does
not interfere with Manifest V2 extensions. You
can remove the Manifest V2-based extensions as
needed.

How to remove the MV2 extension? For Google Chrome: Navigate to
HKEY_LOCAL_MACHINE\SOFTWARE
\WOW6432Node\Google\Chrome\. Expand
Extensions folder and remove the folder by name
kammdlphdfejlopponbapgpbgakimokm.
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For Microsoft Edge: Navigate to
HKEY_LOCAL_MACHINE\SOFTWARE
\WOW6432Node\Microsoft\Edge. Expand
Extensions folder and remove the folder by name
dbmodiepejcigljbmeebedkmegndokbk.
Alternatively, go to the Extensions page of your
respective browser and remove the entry related to
Manifest V2.

How to remove the MV3 extension? For Google Chrome: Navigate to
HKEY_LOCAL_MACHINE\SOFTWARE
\WOW6432Node\Google\Chrome\. Expand
Extensions folder and remove the folder by name
bboccnojhhoegfffpcllbeigipedjedf.
For Microsoft Edge: Navigate to
HKEY_LOCAL_MACHINE\SOFTWARE
\WOW6432Node\Microsoft\Edge. Expand
Extensions folder and remove the folder by name
bboccnojhhoegfffpcllbeigipedjedf.
Alternatively, go to the Extensions page of your
respective browser and remove the entry related to
Manifest V3.

How to force enable Google Chrome or
Microsoft Edge extension for user-specific Bot
agents?

You can force enable the Manifest V3 extension
on Google Chrome or Microsoft Edge by running
the .reg files for Manifest V3. См. раздел Manifest
extension manual upgrade.

How to add an extension force group policy
if another extension policy has already been
added by my IT team?

If a key by name 1 is already present, create a key
name with the subsequent number, in this case, 2.
See the following articles:
• ExtensionInstallForcelist for Google Chrome
• ExtensionInstallForcelist for Microsoft Edge.

I have installed the latest Bot Agent and am
currently on Automation 360. However, I
ignored the browser extension pop-up dialog
box. What do I do?

If you updated the Bot Agent when you launched
a browser, you will be prompted to add or remove
the Manifest V3 extension with a pop-up dialog
box. To enable the Manifest V3 extension, you must
select the Add Extension option. If you ignore
the pop-up dialog box, the Manifest V3 extension
is disabled. To enable the extension and apply the
group policy, you must restart your browser.

How do I continue to use Manifest V2
extensions with Automation 360 v.26 and
later versions?

We recommend that you upgrade to the latest
Automation 360 version to get the benefits of
Manifest V3 extensions. However, if you still want
to continue using Manifest V2 based extensions,
ensure that you disable the Automatically
update all bot agents option (in the Control
Room settings) for all devices and ensure that
users do not install the latest Bot Agent. This is
required because the Automation 360 v.26 Bot
Agent supports only Manifest V3 extensions.
You can continue using Manifest V2 extensions until
for Google Chrome until Jan 2024 (see Manifest V3
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transition timeline). To know about Microsoft Edge
Manifest V2 extensions timelines, see Overview and
timelines for migrating to Manifest V3.

Related concepts
Chrome and Edge Manifest V3 extensions on page 812
As Google will deprecate Manifest V2 extensions , this might impact your existing automations that use
the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers. We have published
Manifest V3 extensions with the Automation 360 v.26 release to help you start switching to Manifest V3
extensions.
Manually upgrade from Manifest V2 to V3 extensions for Chrome and Edge
Feature deprecations affecting Automation Anywhere products on page 763
Review the features and capabilities (from Automation Anywhere or third party) that are deprecated or
nearing deprecation to understand how they affect your automation and what action is required.

Manage multiple browser profiles for Manifest V3 extension
Automation 360 v.26 automatically includes Manifest V3 extensions to support browser-based automation.
However, these V3 extensions in v.26 are by default for a single browser profile only.
You can enable browser extension for only one browser profile at a time. If you have multiple browser
profiles, you must enable browser extension only from the profile that is used to run the боты. You must
disable the Automation 360 browser extension from all other browser profiles. You also have the option to
debug logging, for troubleshooting purposes.

Note:  This procedure is applicable only if your browser is using Manifest V3 extension.

To enable or disable the browser extension individually for each browser profile, perform these steps:
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1. Open the Google Chrome or Microsoft Edge browser:
• On Microsoft Edge, navigate to Extensions > Automation 360 > Extension Options.
• On Google Chrome, navigate to chrome://extensions/ and select Details in Automation 360

and select Extension options.

The following page is displayed:

2. Select or deselect the Enable Automation 360 extension for this browser profile option.

Note:  When you enable this option, only the current active profile is used for communication with the
Bot Agent.

3. Select the Enable debug logging option to troubleshoot any browser extension issues.
4. Click Save and then restart the browser for the changes to take effect.
5. Verify that the debugging option is enabled for this browser profile by performing these steps:

a) Press F12 key or Ctrl+Shft+I keys on an active browser window.
b) In the Developer console, select the Application tab and then select Service Workers.
c) Click See all registrations.

In the Service Workers window, the extension ID in chrome://extensions and the ID in the
ServiceWorker window will be the same. Also, the Log field displays the logs continuously.

Related concepts
Manifest V3 extensions FAQ on page 815
As Google will deprecate Manifest V2 extensions by June 2023, this might impact your existing automation
that use the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers.
Manually upgrade from Manifest V2 to V3 extensions for Chrome and Edge
Related tasks
Switch Manifest V3 to Manifest V2 extension manually on page 824
If you want to switch from Manifest V3 extension to Manifest V2 extension while remaining on Automation
360 v.26, you can manually switch to v2 extension.
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Switch Manifest V3 to Manifest V2 extension manually
If you want to switch from Manifest V3 extension to Manifest V2 extension while remaining on Automation
360 v.26, you can manually switch to v2 extension.
To switch Manifest V3 extension to Manifest V2 extension manually, perform these steps:
1. Disable the Manifest V3 extension from the browser extension options.

См. раздел Manage multiple browser profiles for Manifest V3 extension on page 822.
2. Edit the browser agent JSON file to replace the browser extension ID.

• Chrome
a. Navigate to C:\Program Files\Automation Anywhere\Bot Agent\AABrowserAgent

\.
b. Open the AAChromeAgentManifest.json file.
c. Replace the browser extension ID bboccnojhhoegfffpcllbeigipedjedf to

kammdlphdfejlopponbapgpbgakimokm.
d. Restart the browser for the changes to take effect.

• Edge
a. Navigate to C:\Program Files\Automation Anywhere\Bot Agent

\AABrowserAgent.
b. Open the AAEdgeAgentManifest.json file.
c. Replace the browser extension ID from fnmjcdajlonpigpcfnemeikipmolbfii to

dbmodiepejcigljbmeebedkmegndokbk.
d. Restart the browser for the changes to take effect.

Alternatively, download the JSON files from the link given below, and replace the files at the Bot
Agent installation location ( typically located at C:\Program Files\Automation Anywhere\Bot
 Agent\AABrowserAgent) on your Bot Agentmachines.
• For Chrome: Download the AAChromeAgentManifest.json from Google Chrome JSON file

download for Manifest V2.
• For Edge: Download the AAEdgeAgentManifest.json file from Microsoft Edge JSON file

download for Manifest V2.

If you have uninstalled the Manifest V2 extension manually, you must reinstall it from the Chrome web store.
Otherwise, your web-based automation might not continue to work.
If you are facing any issues, see Google Chrome extension troubleshooting on page 1974.
Related concepts
Manifest V3 extensions FAQ on page 815
As Google will deprecate Manifest V2 extensions by June 2023, this might impact your existing automation
that use the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers.
Chrome and Edge Manifest V3 extensions on page 812
As Google will deprecate Manifest V2 extensions , this might impact your existing automations that use
the current Manifest V2 extensions for Google Chrome and Microsoft Edge browsers. We have published
Manifest V3 extensions with the Automation 360 v.26 release to help you start switching to Manifest V3
extensions.
Manually upgrade from Manifest V2 to V3 extensions for Chrome and Edge
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Deprecation of Tesseract OCR v3
IQ Bot will permanently discontinue Tesseract OCR v3 starting from Automation 360 v.26. This affects
customers who have created learning instances using Tesseract OCR v3. We recommend that you plan
to train your learning instances with alternative OCRs (including Tesseract OCR) before you update to
Automation 360 v.26.
Removal of Tesseract OCR will affect the following product areas:
• My Learning Instances page:

For all Tesseract3 OCR learning instances, the Set the instance to Production button and Launch
Validator button are unavailable.
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• My Learning Instance details page:
• Select the Tesseract OCR v3 learning instance and go to the Learning Instance details page.
• The Set to staging, Add group, Validate, Edit, and Train buttons are unavailable.
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• Edit Bot page:
• In the My Learning Instance page, click the Edit bot button of any existing бот.

• The See extraction result, Save and close, Save and go to next group, and Delete Bot
buttons are unavailable.
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• Bot page:
• Go to Bot page.

• Click Test.

• The following error message is displayed:
The learning instance references OCR version which is not available -
Tesseract 3
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• There is no change in the Dashboard page, and it continues to show Tesseract 3 metrics.

© 2023 Automation Anywhere. All rights reserved.     829



    Automation Anywhere - Install and update Automation 360

Install and update Automation 360
Automation 360 provides a web-based, cloud-native RPA platform for users of all types. Review the tasks
involved in setting up Automation 360.

Legal disclaimer:  The information provided in this workflow might vary depending on which offering you
use. Administrator steps might not be applicable to Cloud or Community Edition.

1. Choose your Automation 360 deployment model.

Модели развертывания
2. Verify the system prerequisites based on your deployment model:

• Cloud: Automation 360 Cloud prerequisites
• On-Premises: Automation 360 On-Premises prerequisites
• Community Edition: Начните с Community Edition

3. Administrators: Set up бот users.
Бот users, skip this step and proceed to Step 4.
a. Receive your administrator credentials.

• Cloud administrators: Receive your login credentials with administrator privileges and your
Automation 360 dedicated URL from Automation Anywhere.

• On-Premises administrators: Receive your licensing information from Automation
Anywhere and install Automation 360.
The installation user is assigned administrator privileges.

Тип установки Go here

Окна Installing Control Room On-Premises

To view this installation task in an
interactive visual format, see Install
Control Room On-Premises (custom
mode).

Linux Installing Control Room on Linux

Amazon Web Services Installing Control Room on Amazon
Web Services

Microsoft Azure Installing Control Room on Microsoft
Azure
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Тип установки Go here

Google Cloud Platform Installing Control Room on Google
Cloud Platform

b. Log in to a supported device, open a supported web browser, and log in to your Control Room
using the dedicated URL.
• Automation 360 Bot Runner device requirements
• Вход в Automation Anywhere Control Room

c. Create your бот users by assigning a role and device license.
• Create a user
• Создание пользователя Active Directory

d. Set up email notifications to Control Room users when events affect them, such as changes to
passwords or user information, and account activation or deactivation.

4. Пользователи Бот. Perform these steps to get started with Automation 360.
a. Receive your user login credentials and the Control Room dedicated URL.

Credentials are sent to you from your company's Automation Anywhere administrator or from
Automation Anywhere.
Community Edition users: If you do not have an Automation 360 account, register for a free
Community Edition account by visiting Automation Anywhere Community Edition.

b. Log in to your Automation 360 account.
Log in to a supported device, open a supported web browser, and log in to your Control Room.
• Automation 360 Bot Runner device requirements
• Вход в Automation Anywhere Control Room

c. Установка Bot Agent и регистрация устройств.

Прим.:  The Bot Agent is installed only on devices running supported Windows operating
systems. См. раздел Automation 360 Bot Runner device requirements. You can create боты using
the Bot editor in the Control Room, but to run the боты you must install the Bot Agent on your
device.

d. Start creating боты:
• Создание первого бот
• Build a Go be Great бот

Update Automation 360:  См. раздел Обновление до последней версии Automation 360.
Cloud and the Community Edition are updated automatically.

Задачи, связанные с данной
Вход в Automation Anywhere Control Room
Чтобы войти в Automation 360, откройте URL-адрес Control Room в браузере, введите свои учетные
данные на экране входа и нажмите кнопку Вход.
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Начните с Community Edition
Use these tasks to register for, and start creating and using боты with the Community Edition of
Automation 360.
Ссылки, связанные с данной
Automation 360 Bot Runner device requirements
Review the machine hardware specifications, operating system versions, and browser types supported
for creating and running боты on a device. The same requirements are also valid for Automation 360
Community Edition.
Требования к браузеру для доступа к Рабочая область RPA
Доступ к интерфейсу Рабочая область RPA из браузера. After you have installed and enabled
extensions in the browser, perform several tasks through the Рабочая область RPA interface based on
your user role and automation requirements.
Информация, связанная с данной
Install and update Automation 360 IQ Bot
Enterprise v11 Control Room installation
Enterprise v11 Client installation

Начните с Cloud Automation 360
Use these tasks to start creating and using боты with Automation 360 Cloud.
1. Complete the prerequisites for Cloud.

Automation 360 Cloud prerequisites

Use the checklist to determine whether your device fulfills the requirements for registering with
Automation 360 Cloud.

2. Provision Cloud Control Room instances.
Use the Licenses and Cloud Services portal to provision Cloud Control Room and Cloud sandbox
Control Room instances on demand.

3. Receive your Control Room URL and login credentials. The URL points to your Automation 360
instance.
If you are your company's principal administrator and ordered cloud-deployed Automation 360, you
receive an email from Automation Anywhere with your URL and credentials.

4. Вход в Automation Anywhere Control Room.
To log in to Automation 360, open the Control Room URL in your browser, enter your credentials in the
login screen, and click Log in.

5. Install Bot Agent, register your device, and set user device credentials.

Установка Bot Agent и регистрация устройств | Set user device credentials

The Bot Agent is a lightweight application that enables you to run боты on your device by connecting
the device to the Control Room. To run боты on a local machine, install the Bot Agent and add the
local device to the list of enabled host devices.
To enable a device for running боты, set the local device credentials.
If you are using an operating system other than Windows, you will not be able to install the Bot Agent
at this time. See system requirements. However, you can still build боты using the Bot editor.

6. Создание первого бот.
Follow these steps to create your first бот that prints the message, Go be great!, the Automation
Anywhere version of Hello World!
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7. Run your first бот.
Run a бот from the same device that you used to create the бот.

Video resources

• Introduction to Automation 360

• Installing the Bot Agent in Automation 360:

• Building your first бот:

• Running your first бот in the Community Edition:

Информация, связанная с данной
Cloud RPA

Automation 360 Cloud prerequisites
Use the checklist to determine whether your device fulfills the requirements for registering with
Automation 360 Cloud.
• Verify the device software and hardware requirements.

Automation 360 Bot Runner device requirements
• Access the Control Room URL from your browser.

Вход в Automation Anywhere Control Room
• Add the Automation Anywhere Domain Name System (DNS) to the safe recipients or allowed list to

ensure secure access to Automation 360 cloud services.
Add Automation 360 Cloud URLs to trusted list

• Allow Automation Anywhere communications ports and protocols.
Allow Automation Anywhere communications ports

• Add devices to the allowed list within the corporate network for granular security.
Add access IP addresses

• Add or update the authenticating proxy credentials to connect your device.

Подключение Bot Agent к устройству с использованием прокси-сервера
• Set up SAML authentication identity provider if you are using single sign-on (SSO).

Настройка аутентификации SAML
• Configure your network firewall to add the outbound NAT Gateway IP addresses to the allowed list.

Automation 360 IP addresses for external integrations
• When configuring your domain and subdomain Control Room URLs, you must follow the Domain Name

System (DNS) guidelines.
Naming guidelines for Control Room URLs

• To ensure seamless connectivity of your IQ Bot cloud servers with the Cloud Control Room, specify a list
or range of IP addresses that are allowed to access the Cloud Control Room URL.
Add IQ Bot cloud server IP addresses to allowed list
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Automation 360 Bot Runner device requirements
Review the machine hardware specifications, operating system versions, and browser types supported
for creating and running боты on a device. The same requirements are also valid for Automation 360
Community Edition.

Hardware requirements for registered devices

You communicate with the Control Room, through a registered local machine (device). Bot Creator and Bot
Runner use the registered devices to create and run боты. Part of registering a device with Automation
360 is installing a Bot Agent.
The Bot Agent can be installed on devices that meet or are equivalent to the following hardware
requirements:

Устройство Processor RAM Storage (free disk
space)

Network

Machine Intel Core i3 2.6
GHz with 4 multi-
cores or higher
64-bit

• 4 GB
(Minimum)

• 8 GB
(Recommended)

32 GB
Add 100 through
150 KB per
Automation
Anywhere script
Add 40 through 50
GB per long-term
project

• 5Mbps
(Minimum)

• 20Mbps
or higher
(Recommended)

Additional users
on a multi-user
device

2 CPU per
additional user

4 GB per
additional user

No additional
storage required

No additional
network needed

Additional RAM requirements for the
registered devices

Add additional RAM to account for applications
and services running on the registered devices, for
example:
• Microsoft Office applications (example: Excel)
• Browsers (example: Google Chrome)
• Enterprise applications (example: CRM, Oracle

EBS, and SAP)
• VDI infrastructure applications
• Anti-virus software
• AISense Recorder

Additional disk space on registered devices • Automation 360 scripts average approximately
100-150 KB. Additional free disk space is
required to develop automation projects because
temporary files such as screenshots, server logs,
and audit files are created during the execution
of the automation scripts.

• Free space required increases with the project
size. Recommendation: Have at least 40-50 GB
of free disk space for each long-term project.
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• Increase storage space configuration after
installation, as needed, depending on product
usage. For example, depending upon the
complexity of your бот, generating log files and
logic creation require additional disk space later.

Additional CPU or processor on registered devices

AISense Recorder: Additional CPU or processor is required on a device if the existing CPUs are utilized
by customer applications. It is also required in case of a VDI infrastructure where CPU or processors are
shared across the infrastructure.

Platform compatibility for registered devices

A device used to connect to the Control Room and perform бот tasks must meet the platform
requirements.

Прим.:  Platform requirements are different for Control Room and Bot Agent.

Registered devices Physical machines that you want to use for creating
боты or deploying боты and running any of the
supported operating systems.

Серверы терминалов Using remote desktop (RDP), running any of the
supported operating systems is supported on
Automation 360 Version A2019.11 or later.

Виртуальные машины Bot Agent is supported on all VMs where the
supported Windows OS has been hosted on Version
A2019.09 or later. For example, Virtual Desktop
Infrastructure (VDI) are supported on Amazon Web
Services, Microsoft Azure, Google Cloud Platform,
VMware virtual machines, and Oracle Virtual Box.

Supported operating systems for registered devices
A device used to run the Bot Agent, connect to the Control Room, and perform бот tasks as a Bot Creator
and Bot Runner must meet the operating system requirements.

Прим.:
• Only 64-bit operating system version supported.
• Задачи Bot Creator поддерживаются всеми перечисленными операционными системами.
• Вы не можете зарегистрировать устройство, работающее под управлением Linux. Bot Agent не

может быть установлен на системах Linux. Однако вы можете использовать зарегистрированное
устройство, работающее в системе Windows, для доступа к Control Room, установленному в
системе Linux.
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Windows version Windows edition Bot Runner с
сопровождением

Bot Runner без
сопровождения

Bot Creator

Windows Server
2019

Datacenter and
Standard

Supported Supported1 Supported

Windows Server
2016

Datacenter and
Standard

Supported Supported1 Supported

Windows Server
2012

Datacenter and
Standard

Supported Supported1 Supported

Windows 11 Предприятие Supported Supported1 Supported

Windows 10 Professional and
Enterprise

Supported Supported1 Supported

Windows 8 2 Professional and
Enterprise

Supported Supported Supported

Windows 7 2 Professional and
Enterprise

Supported Supported Supported

(1) Auto-login • Auto-login is only supported on 64-bit systems.
• If the Auto-login fails, configure the Local

Security Policy settings. For example, in
Windows, select Security Settings > Local
Policies > Security Options. Enable the
Interactive logon > Do not require CTRL
+ALT+DEL option.

(2) Supported OS Windows 11 (64-bit) supported on Automation 360
Сборка 15459 or later.
Windows 8 (64-bit) supported on Enterprise A2019
(Builds 1598 and 1610) or earlier.
Windows 7 (64-bit) supported on Enterprise
A2019.12 or later.

Add Automation 360 Cloud URLs to trusted list
To ensure secure access to Automation 360 cloud services, add the URL specific to the service to the safe
recipients or trusted list.

Automation 360 Cloud URLs list

Automation 360 cloud service hosting uses dynamic IP addresses and therefore we recommend that you
add to the safe recipients list the complete URL instead of an IP address for the Automation Anywhere
cloud services.

Служба URL-адрес Порт Устройство

Automation Anywhere www.automationanywhere.comTCP 443 (HTTPS) All devices
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Служба URL-адрес Порт Устройство

Automation Anywhere Cloud
customer tenant
Includes Automation
Anywhere Control Room and
IQ Bot

crdomainname-
X.my.automationanywhere.digital

Прим.:
• crdomainname-X refers

to your specific tenant
name.

• The tenant name
does not support
the underscore ( _ )
character. So an
underscore is used in
the tenant name, the
specified URL will not be
created.

TCP 443 (HTTPS) All devices that
access Automation
360

Automation Anywhere Bot
Agent download link

aai-
artifacts.my.automationanywhere.digital/

TCP 443 (HTTPS) All devices that
access Automation
360

Automation Anywhere
community (A-People)

apeople.automationanywhere.comTCP 443 (HTTPS) All devices

Automation Anywhere
documentation

docs.automationanywhere.comTCP 443 (HTTPS) All devices

Bot Store botstore.automationanywhere.comTCP 443 (HTTPS) All devices

Content delivery network
(CDN)
Enables your platform
to perform faster as it
geographically distributes
common static content for
cloud tenants.

aai-
artifacts.my.automationanywhere.digital

TCP 443 (HTTPS) All devices that
access Automation
360

Telemetry
Allows performance and
usage information to be
gathered anonymously in
order to improve product
quality.

• cdn.pendo.io/
• app.pendo.io/
• data.pendo.io/
• https://pendo-

static-5673999629942784.storage.googleapis.com/

TCP 443 (HTTPS) All devices
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Служба URL-адрес Порт Устройство

Automation Anywhere
Google Chrome extension
Enables you to automate
using the Google Chrome
browser.

MV3 extension
https://
chrome.google.com/
webstore/detail/
automation-360/
bboccnojhhoegfffpcllbeigipedjedf

MV2 extension
https://
chrome.google.com/
webstore/detail/
automation-360/
kammdlphdfejlopponbapgpbgakimokm

TCP 443 (HTTPS) Bot Creator
and Bot Runner
devices

Automation Anywhere
Microsoft Edge extension
Enables you to automate
using the Microsoft Edge
browser.

MV3 extension
https://
microsoftedge.microsoft.com/
addons/detail/
automation-360-beta/
fnmjcdajlonpigpcfnemeikipmolbfii

MV2 extension
https://
microsoftedge.microsoft.com/
addons/detail/
automation-360/
dbmodiepejcigljbmeebedkmegndokbk

TCP 443 (HTTPS) Bot Creator
and Bot Runner
devices

Automation Anywhere
Mozilla Firefox extension
Enables you to automate
using Mozilla Firefox
browser.

https://
addons.mozilla.org/
en-US/firefox/addon/
automation-360

TCP 443 (HTTPS) Bot Creator
and Bot Runner
devices

Файлы и папки

For information on files and folders to add to the safe list and to the antivirus exception list, see these
articles:
• Files and URLs to add to safe list for Automation 360 (A-People login required)
• List of files to add to antivirus exception list for Automation 360 (A-People login required)

Задачи, связанные с данной
Add access IP addresses
Use this setting to limit user login access to the Control Room URL based on IP addresses or subnets that
you specify in a list. You add IP address ranges using the Classless Inter-Domain Routing (CIDR) format,
and you can add multiple CIDR ranges.
Ссылки, связанные с данной
Требования к портам, протоколам и брандмауэру
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Просмотрите требования по умолчанию и настраиваемые требования к брандмауэру, портам и
протоколам для развертывания Automation Anywhere. View the default ports and protocols that are
required to be allowed on customer's firewall for Automation Anywhere deployment. The default ports that
are used for HTTP/HTTPS are configurable.
Add Automation 360 On-Premises URLs to trusted list
To ensure secure access to Automation 360 online services for On-Premises deployment, add the URL
specific to the service to the safe recipients or trusted list.
Add IQ Bot cloud server IP addresses to allowed list
To ensure seamless connectivity of your IQ Bot cloud servers with the Cloud Control Room, specify a list or
range of IP addresses that are allowed to access the Cloud Control Room URL.
Automation 360 IP addresses for external integrations
To ensure seamless connectivity of your Git instance, On-Premises key vault, or SIEM with the Cloud
Control Room, configure your network firewall to include Automation Anywhere outbound Automation 360
IP addresses to the allowed list.

Allow Automation Anywhere communications ports
As part of the Automation 360 Cloud prerequisites, you must allow Automation Anywhere communications
ports and protocols from the customer network.

Cloud communications ports

You can set the following connection modes between the customer network and the Control Room:
• Outbound: The traffic flows from the customer network to the Control Room.
• Inbound: The traffic flows from the Control Room to the customer network.

Прим.:
• You do not need an inbound connection for a regular бот execution. The inbound connection is only

required when you have configured any integrations to: Git repository, On-Premises external key vault,
or SIEM server with your cloud-hosted Control Room.

• You must open the Cloud communications ports to unidirectional (outbound connection) to transmit
traffic from the customer network to the cloud-hosted Control Room.

The following table describes the required Cloud communications ports:

Automation 360 Cloud communications ports

С До Порт Протокол Тип
подключения

Bot Agent
(customer hosted)

Control Room
(Automation
Anywhere hosted)

443 HTTPS Outbound

Bot Agent
(customer hosted)

Control Room
(Automation
Anywhere hosted)

443 WebSocket Outbound

Access to Control
Room through
browser

Control Room
(Automation
Anywhere hosted)

443 HTTPS Outbound
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Automation 360 Cloud communications ports

С До Порт Протокол Тип
подключения

Control Room
(Automation
Anywhere hosted)
where Control
Room connects
from these
Automation 360
IP addresses
for external
integrations

Third-party
Keystore
(customer hosted
and optional)

443 HTTPS Inbound

Control Room
(Automation
Anywhere hosted)
where Control
Room connects
from these
Automation 360
IP addresses
for external
integrations

Git Repository
(customer hosted
and optional)

443 HTTPS Inbound

Control Room
(Automation
Anywhere hosted)
where Control
Room Room
connects from
these Automation
360 IP addresses
for external
integrations

SIEM server
(customer hosted
and optional)

443 HTTPS Inbound

Add IQ Bot cloud server IP addresses to allowed list
To ensure seamless connectivity of your IQ Bot cloud servers with the Cloud Control Room, specify a list or
range of IP addresses that are allowed to access the Cloud Control Room URL.
Based on your region, add the following outbound NAT IP addresses to the allowed list in the Cloud Control
Room network settings:

Область IP addresses

- Africa • 13.244.57.44
• 13244197159
• 13.244.185.72
• 54.228.5.1
• 54.228.48.30
• 54217103248
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Область IP addresses

- Australia • 54153153175
• 52.65.8.56
• 3106147142

- Canada • 35.203.94.19
• 34.152.28.44

- EU West 1 • 108128188103
• 63.34.200.237
• 52.30.160.238
• 18.197.15.181
• 18.195.27.35
• 3.123.208.13

- EU West 4 • 35204101230
• 34141232185
• 34.141.55.27
• 34.141.57.227

India • 3.7.60.137
• 3.6.235.61
• 13.232.116.48
• 18.136.73.65
• 52.77.203.34
• 18.136.8.15

- Japan • 18177157130
• 18.176.174.19
• 3114196205
• 54.169.202.27
• 52.221.25.42
• 18.140.96.19

- LATAM • 54.94.241.48
• 18.229.39.93
• 52.67.153.170
• 34.195.218.48
• 3.211.67.78
• 3.228.163.41
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Область IP addresses

- Middle East • 15.185.153.52
• 15185181122
• 157.175.32.98
• 52213112204
• 54154112221
• 34.242.58.85

- Sandbox Australia • 34.151.71.179
• 35.189.24.10

- Sandbox EU West • 54.228.82.108
• 54.73.17.42
• 54.228.85.241
• 3.122.33.207
• 35.156.216.8
• 18159235149

- Sandbox US West • 35164189142
• 35166154241
• 35.160.254.91
• 35.168.234.8
• 34204215165
• 54.92.237.118

- Singapore • 18.141.71.43
• 54.251.139.55
• 18136253184
• 18.176.165.62
• 52.68.115.49
• 54168135182

- US Central • 34.85.131.101
• 35245151203
• 34.68.252.217
• 34.123.71.95

- US East • 50.16.245.134
• 35.174.84.76
• 3.210.114.16
• 54.244.136.23
• 54.185.77.190
• 44234224213
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Область IP addresses

- US West • 54213119159
• 34.218.159.79
• 52.33.16.117
• 3.225.222.13
• 34197160162
• 3.213.188.29

- Sandbox US Central • 35.223.219.53
• 34.133.80.165
• 34150165212
• 35245150192

- Sandbox Singapore • 13251176239
• 54.169.33.175
• 46.137.201.87

Задачи, связанные с данной
Add access IP addresses
Use this setting to limit user login access to the Control Room URL based on IP addresses or subnets that
you specify in a list. You add IP address ranges using the Classless Inter-Domain Routing (CIDR) format,
and you can add multiple CIDR ranges.
Ссылки, связанные с данной
Add Automation 360 Cloud URLs to trusted list
To ensure secure access to Automation 360 cloud services, add the URL specific to the service to the safe
recipients or trusted list.

Installing Control Room On-Premises
Review the installation core tasks and topics for installing the Automation 360 Control Room in a data
center on an On-Premises server or a cloud service provider server instance.
The Control Room provides centralized management for a digital workforce and an interface for Bot
Insight. It is deployed on a server in a data center.

Linux users:  See Installing Control Room on Linux.

Прим.:  Linux is not supported for Cloud-enabled On-Premises installations.

Control Room installation core tasks

Prerequisites
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Before you begin, download the appropriate installer for your operating system and version from A-People
Downloads page (Login required).

Step 1: Pre-installation Automation 360 On-
Premises prerequisites

Determine whether the
system has the required
hardware and software
to install Control Room
for On-Premises.

Step 2: Installation The Control Room installer allows you to select
installation modes (Express or Custom), and during
the installation process, it also installs missing
software dependencies.
Use Custom mode to install on a cloud-based
platform such as Amazon Web Services.

Installing Control Room
using Express mode

Log in to the servers
as an Administrator
and install Automation
Anywhere Control Room
in Express Mode using
the default settings.

Installing Control Room
using Custom mode

Log in to the server
as an administrator
and install Automation
Anywhere Control Room
in Custom mode to
select installation and
configuration options,
including installing non-
default requirements.
Select this mode for a
data center deployment.

Workflow map:  To
view this installation
task in an interactive
visual format, see
Install Control Room On-
Premises (custom mode).

Installing Control Room
on Microsoft Windows
Server using scripts

Silent Control Room
installation, also
known as unattended
installation, uses a
customized script for
a full setup or the
command line for a
hot fix patch. Silent
install runs the entire
installation process
in the background
without requiring user
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interaction or displaying
messages.

Step 3: Post-installation Configuring post-
installation settings

The options for
launching the Control
Room for the first time
and the authentication
method depend on the
installation mode and
deployment type.

Verifying Automation
Anywhere services

Automation Anywhere
specific services are
installed on the Control
Room server.

Step 4: Validation Configure Control Room
authentication options

The options for
launching the Control
Room for the first time
and the authentication
method depend on the
installation mode and
deployment type.

Automation 360 On-Premises prerequisites
Determine whether the system has the required hardware and software to install Control Room for
Automation 360 On-Premises.

Требования к аппаратному обеспечению

Control Room server requirements The Control Room is deployed on servers in data
centers. The minimum Automation Anywhere
hardware requirements include: server type,
machine type, processor, RAM, disk storage, and
network requirements.

Операционная система, окружение и платформа,
поддерживаемые для Control Room

Automation 360 can be hosted on AWS, Microsoft
Azure, Google Cloud Platform, IBM, and any public,
private, or hybrid cloud service that meets the
Control Room and Bot Agent hardware and software
requirements.

Совместимость Bot Agent Bot Agent is the Automation 360 plug-in that
enables you to create and run боты. The agent
is installed on devices used to access the Control
Room. Installing the Bot Agent is part of registering
a device.

Credential requirements Login credentials are required at different stages
of Automation Anywhere deployment and use.
Credentials are required for installation and data
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center servers, access to Automation Anywhere
components, and to run tools in боты.

Supported cloud platforms Review the supported cloud platforms for various
Automation 360 features.

Data center requirements

Database requirements Working with SQL Servers Configure Microsoft SQL
Servers before setting
up the Control Room
database.

Working with Azure SQL
PaaS

Using PaaS SQL
database with Azure
requires configuration
from the Azure instance.

Load balancer requirements View the load balancer requirements for Automation
Anywhere installation. This includes load balancer
minimum requirements, and both TCP and HTTPS
layer load balancing requirements.

Требования к портам, протоколам и брандмауэру View the default and configurable firewall, port, and
protocol requirements for Automation Anywhere
deployment.

Требования к браузеру для доступа к Рабочая
область RPA

The user interface for Automation 360 (On-Premises
or Cloud deployed) and for Community Edition is
accessible through a browser.

HA and DR deployment models High availability
deployment

The high availability
(HA) deployment
model provides failure
tolerance for the Control
Room servers, services,
and databases using
a distributed load
balancer.

Disaster recovery
deployment

The disaster recovery
(DR) deployment model
uses high availability
(HA) clusters distributed
across separate
geographic areas.

Single-node deployment A single-node
deployment hosts the
Control Room only on
one server or machine.
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Additional requirements

Configure application Transport Layer Security Use the Transport Layer Security (TLS)
configuration wizard page from the Automation
360 installer to generate a self-signed certificate
or import a security certificate to set up a highly
secure Control Room instance.

Naming guidelines for Control Room URLs When configuring your domain and subdomain
Control Room URLs, you must follow the Domain
Name System (DNS) guidelines.

See also this article on the Automation Anywhere support site: Automation 360 On-Premises prerequisites (A-
People login required).
Понятия, связанные с данным
Installing Control Room on Microsoft Azure
Installing Control Room on Microsoft Azure begins in the Azure environment and ends with configurations
in the Control Room.
Installing Control Room on Amazon Web Services
Log in to an Amazon Web Services (AWS) server instance as Administrator. Then, download and start the
Control Room installer and select Custom mode.
Installing Control Room using Custom mode
Log in to the server as an administrator and install Automation Anywhere Control Room in Custom mode to
select installation and configuration options, including installing non-default requirements. Select this mode
for a data center deployment.
Задачи, связанные с данной
Installing Control Room using Express mode
Installing Control Room on Microsoft Windows Server using scripts
Silent Control Room installation, also known as unattended installation, uses a customized script for a full
setup or an update setup. Silent installation runs the entire installation process in the background, without
requiring user interaction or displaying messages.

Capacity and performance planning
To plan your deployment capacity and performance for Control Room On-Premises, understand the
requirements, limits, and defaults that determine the number of simultaneous боты, user sessions, and
processing rates.
The following topics provide information to help you calculate a deployment scenario that meets your
requirements.

Одновременные развертывания и выполнения
бот

To plan your deployment capacity and performance
for Control Room On-Premises, understand the
requirements, limits, and defaults that determine
the number of simultaneous боты, user sessions,
and processing rates.

Одновременные развертывания и выполнения бот
Ознакомьтесь с информацией о максимальном количестве одновременных операций развертывания
и выполнения бот для среды On-Premises.
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Обзор

The entity count in the following list provides information only about the maximum number of entities
that the Control Room can support irrespective of the machine resources. Deploying additional machine
resources does not increase the entity count.
Control Room поддерживает один из указанных ниже вариантов для максимального числа
одновременных развертываний и выполнений бот.
• 1000 одновременных развертываний и выполнений бот в сеансах Bot Runner (обычно в Control

Room производства)
• 700 одновременных развертываний и выполнений бот в сеансах Bot Creator (обычно в Control

Room разработки)

Тип объекта Счетчик

Пользователи 10 000*

Функции 5000*

Расписания 1500

Записи аудита 10 000 000*

Ячейки 100

Учетные данные 5000

Файлы репозитория
(Включая все типы файлов в рабочей области
Общие Control Room)

Прим.:  Файлы репозитория включают
зависимые файлы, которые вы регистрируете
в рабочей среде Общие, (видимые в
пользовательском интерфейсе) и связанные
файлы из базы данных (невидимые в
пользовательском интерфейсе). Например,
файлы .png, созданные после записи
автоматизации, сохраняются в базе данных и
включаются в файлы репозитория.

25 000*

Папки репозитория 9000*

Очереди 10

Группы устройств 10

Work Items 1000000

* Применимо для Automation 360 v.21 и более поздних версий.

Одновременные развертывания и выполнения

Control Room поддерживает до 1000 одновременных развертываний и выполнений бот в рамках
кластера Control Room. These 1000 боты can be a combination of the same or different боты.
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Прим.:  If you use different боты, because of the load, the compiler slows down the execution for the
first-time deployment. For subsequent deployments, бот execution process might accelerate.

Редакция и конфигурация Control Room Число пользователей Запустить как

Один экземпляр On-Premises Максимум 1000

Три экземпляра On-Premises с конфигурацией
высокой доступности (HA)

Максимум 1000

Развертывание бот зависит от качества сети и размера данных, которые необходимо передать из
Control Room в Bot Agent.
Таким образом, в описанном выше сценарии, когда скорость сетевого подключения увеличивается
для трех экземпляров Control Room, пропускная способность сети повышается, поэтому время
завершения сокращается, но максимальное допустимое количество одновременных развертываний
бот останется прежним.

Одновременные расписания Бот

Рекомендации по планированию при многократном запуске боты.
При настройке запуска боты несколько раз по расписанию важно проследить, чтобы время между
запусками было не меньше общего времени развертывания и выполнения бот. В противном
случае последовательные выполнения бот могут перекрываться, что приведет к непредвиденному
поведению.
Например, если для выполнения бот требуется две (2) минуты, то не следует планировать запуск
бот каждую одну (1) минуту. Предыдущее выполнение не может завершиться до начала следующего
выполнения.
С помощью эталонной спецификации можно успешно настраивать одновременные расписания.

Действия Данные расписания

Одновременные расписания 100

Пользователь Запустить как по расписанию 10

Всего одновременных боты 1000

Control Room server requirements
The Control Room is deployed on servers in data centers. The minimum Automation Anywhere hardware
requirements include server type, machine type, processor, RAM, disk storage, and network requirements.

Прим.:  Automation Anywhere does not provide any monitoring functions for repository, such disk space
usage, memory, or other alert mechanisms related to repository. There are commercial tools available from
other third-party independent software vendors (ISV) who provide such tools.

The installation wizard requires the following:
• IP addresses: Identify all the nodes (servers) IP addresses in the data center cluster before

installation. You provide these IP addresses during Control Room installation.
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• Access hardware: To enable viewing the Automation Anywhere interface, provide:
• keyboard
• mouse or other pointing device
• monitor with 1366 x 768 or higher resolution

Прим.:  For IQ Bot server requirements, see IQ Bot hardware and software requirements.

Control Room must be installed on a 64-bit, server-level machine, and there can only be one instance of it
on the machine. All previous Control Room versions must first be removed from the server machine before
you begin the installation.
The following are server requirements for Windows and Linux.

Component
server

Processor RAM Storage
(free disk space)

Network

Control Room
Servers

8 core Intel Xeon
Processor or
equivalent 64-bit
Processor with 2.5
GHz plus speed

16 GB 500 GB 1 GbE
• IPv4
• IPv6

Memory utilization: A Control Room configured with the recommended 16 GB RAM utilizes 80 to 90
percent memory in idle condition and up to 95 percent memory under load, for example, concurrent бот
deployments.

Совет:  We recommend that you configure the Control Room network bandwidth to be above 1 GbE for all
inter-cluster communication between or among the following:
• Control Room and database
• All Control Room nodes
• Control Room and Elasticsearch nodes
• Control Room and storage systems
• Database nodes for high availability (HA) and disaster recovery (DR) configuration

Database requirements
View the list of supported databases, database server type, version, hardware, and operating system
requirements, and database backup and recovery requirements.
Automation Anywhere installation creates a database to store бот data and metadata for the analytics
dashboards.

Прим.:  Automation Anywhere does not provide any monitoring functions for database activities, such as
disk space usage, memory, or other alert mechanisms related to databases. There are commercial tools
available from database vendors and other third-party independent software vendors (ISV) who provide
such tools.

For latest updates, see Microsoft SQL Server Hardware and Software requirements.
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Database server hardware requirements

Component
server

Processor RAM Storage Network

Database server 4-core Intel Xeon
Processor with 2.5
GHz plus speed

8 GB 500 GB 1 GbE

Прим.:  If you are hosting the Control Room databases along with other application databases, ensure
that the hardware resources are increased proportionately.

Database server version and operating system requirements

Тип базы
данных

Database
version

Database
edition

Installed OS Supported
platforms

Configuration
requirement

База данных
Microsoft SQL
Server

2019
2017
2016
2014

Предприятие
Экспресс
Стандартная
Developer
(for 2019)

Windows
Server
2008 R2
Standard or
later
Linux
CentOS 7.7
and 7.9
Red Hat
Enterprise
Linux 7.7
and 7.9

Amazon Web
Services
Relational
Database
Service (RDS)

Installed and
configured.
Only option
for Express
installations.
Enable
protocols for
Named Pipes
and TCP/IP.

База данных
Oracle Server

Oracle 19c • Стандартная
• Предприятие

Windows
Server 2012
R2 or later
Linux
CentOS 7.7
and 7.9
Red Hat
Enterprise
Linux 7.7
and 7.9

Amazon Web
Services
Relational
Database
Service (RDS)

Installed and
configured
with
max_string_size
parameter set
to EXTENDED.
Supported
only on non-
container
База данных.
Available only
through an
On-Premises
custom
installation.

• All database versions support all certified operating systems.
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• We have certified Amazon RDS for SQL Server and Azure SQL single database for PaaS deployment.
Note that for Azure SQL, CPU or memory requirements are not applicable because it is a scalable
and high performance Cloud database built on similar lines with SQL Server and certified for PaaS
deployment in Automation 360.

• We recommend hosting the databases on separate hosts to take into account failover scenarios.
• We recommend Enterprise or Standard editions of Microsoft SQL Server database for production use

and to ensure business continuity with HA and DR deployments.
You can configure the Express edition of Microsoft SQL Server for Automation 360 testing and proof of
concept (POC) purposes based on considerations such as limit on data size, SQL agent unavailability,
and DR capabilities.
For more information about scale limits, see Microsoft SQL Server Express edition scale limits.

Required database information for Automation Anywhere installation

When you install Automation Anywhere, you are prompted to provide information specific to the database
type you are using. The following table summarizes the required information.

Microsoft SQL Server database

Required information Описание

Provide credentials for a Microsoft SQL Server
user who has permission to connect to the
database.
Use only supported characters for the
authentication user name and password.
См. раздел Supported special characters. Не
используйте в пароле базы данных точку с
запятой ( ; ).

Database (SQL Server) authentication

Прим.:  Linux installations use this
authentication method

Linux example:
SQL Database server Login ID: sa
SQL Database password: Automation123
sa user authentication is mandatory.

Database names Database names cannot be blank, have spaces,
or include a percent ( % ). Restrict the names
to alphanumeric, period ( . ), hyphen ( - ), and
underscore ( _ ).
Default name: Automation360-Database

Database port Default: 1433
Connection to this port is mandatory.

Secure connection (optional) and certificate Provide a CA certificate. Ensure the certificate
host name and database connection are the
same.
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Microsoft SQL Server database

Required information Описание

Service credentials Provide the user with db_datareader,
db_datawriter, and db_ddladmin
permissions to create databases during
installation.
The preferred method is to use the Domain user
account.

Аутентификация Windows The Windows credentials of the user logged in to
the device to connect to the database server.

Database collation Use the default database collation:
SQL_Latin1_General_CP1_CI_AS

For Oracle Server database information, see Installing Control Room using custom mode for Oracle installation.
Before installing Automation 360, ensure that you have configured additional firewall settings, verified the
connection to the default port and an SQL query with SA user works as expected.
Понятия, связанные с данным
Installing Control Room on Amazon Web Services
Log in to an Amazon Web Services (AWS) server instance as Administrator. Then, download and start the
Control Room installer and select Custom mode.
Installing Control Room on Microsoft Azure
Installing Control Room on Microsoft Azure begins in the Azure environment and ends with configurations
in the Control Room.
Задачи, связанные с данной
Installing Control Room on Linux
You start installing the Automation Anywhere Control Room in the Linux environment and complete the
installation in the Control Room.
Configure default database port
Configure and enable the TCP/IP in the SQL database server to use the default port 1433 when you install
the Control Room.
Ссылки, связанные с данной
Требования к портам, протоколам и брандмауэру
Просмотрите требования по умолчанию и настраиваемые требования к брандмауэру, портам и
протоколам для развертывания Automation Anywhere. View the default ports and protocols that are
required to be allowed on customer's firewall for Automation Anywhere deployment. The default ports that
are used for HTTP/HTTPS are configurable.

Working with SQL Servers
Configure Microsoft SQL Servers before setting up the Control Room database.

Configuring SQL Server Settings

SQL Server settings can be configured in the SQL Server Configuration Manager.
1. Enable protocols for Named Pipes and TCP/IP in SQL Server Network Configuration > Protocols

for MSSQLSERVER.
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2. Double-click TCP/IP to open the properties window.
3. Input the default or custom port number for IPAll in the IP Addresses tab of the TCP/IP Properties

window.
Номер порта по умолчанию: 1433.

4. Щелкните OK.
5. Restart the MSSQLSERVICE for the updates to take effect.

Прим.:  Ensure the Control Room database uses SQL_Latin1_General_CP1_CI_AS as the default
database collation.

Database and Services Matrix
See Database requirements for a list of supported Microsoft SQL Server versions.

Service Credentials Windows Authentication Проверка подлинности SQL

Local System Account • Current logged in user
account is used to create:
• База данных
• Таблицы

• Installer gives db_owner
permission to NT
AUTHORITY\SYSTEM
account.

SQL User account is used to
create:
• Databases
• Таблицы

Domain User Account • Current logged in user
account is used to create
database.

• Domain user account is used
to create tables.

• Installer gives db_owner
permission to domain user
account.

SQL User account is used to
create:
• Databases
• Таблицы

Service User Account For Microsoft Azure
installations, the service
account user needs to have
read/write access to the remote
Microsoft Azure repository share
path.

Ссылки, связанные с данной
Требования к портам, протоколам и брандмауэру
Просмотрите требования по умолчанию и настраиваемые требования к брандмауэру, портам и
протоколам для развертывания Automation Anywhere. View the default ports and protocols that are
required to be allowed on customer's firewall for Automation Anywhere deployment. The default ports that
are used for HTTP/HTTPS are configurable.
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Working with Azure SQL PaaS
Using PaaS SQL database with Azure requires configuration from the Azure instance.
Configure the Azure instance before you install Automation 360.
1. Log in to your Azure account.
2. Navigate to the Azure SQL option.
3. Create a database based on your custom requirements.
4. Enable the firewall option.
5. Add the IP address to safe recipients list for accessing the database.

Install Automation 360 and point the database server to this instance of the SQL database. См. раздел
Customize Control Room installation on Microsoft Azure.

Операционная система, окружение и платформа, поддерживаемые для
Control Room
Automation 360 можно разместить в AWS, Microsoft Azure, Google Cloud Platform, IBM и любой
общедоступной, частной или гибридной облачной службе, которая отвечает требованиям к
аппаратному и программному обеспечению Control Room и Bot Agent.
Automation 360 в настоящее время сертифицирован для работы с AWS, Google Cloud Platform и
Microsoft Azure. Для получения информации о совместимости операционных систем и платформ с Bot
Agent см. матрицы совместимости Bot Agent в Совместимость Bot Agent.
Automation 360 поддерживает 64-разрядную версию операционной системы Microsoft.

Recommendation:  При использовании серверной или клиентской операционной системы включите
Desktop Experience.

Прим.:  When you install the Control Room on Microsoft Windows Server 2012 and 2012 R2 Datacenter, a
warning message indicating installation prerequisites is displayed. However, you can still proceed with the
installation without any issues.

Прим.:  Before you install the Control Room for On-Premises, ensure that you have installed the Visual C
++ Redistributable for Visual Studio 2015 пакет on the Control Room host machine. For more information
about the пакет, see Visual C++ Redistributable for Visual Studio 2015.

The following sections list the environment and deployment types with the release or build number
applicable to each supported operating system:

Microsoft Windows Server 2012 и 2012 R2 Datacenter

Окружение Сборка (версия) Automation 360

• Amazon Web Services Elastic Compute Cloud
(EC2)

• On-Premises: Сборка 4105 (A2019.12) or
later

• Cloud: Сборка 4111 (A2019.12) or later
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Окружение Сборка (версия) Automation 360

• ВМ Microsoft Azure • On-Premises: Сборка 4105 (A2019.12) or
later

• Cloud: Сборка 4111 (A2019.12) or later

• Google Compute Engine • On-Premises: Сборка 7103 (A2019.17) or
later

Microsoft Windows Server 2016 Standard и Datacenter

Microsoft Windows Server 2016 — минимальная рекомендуемая операционная система.

Окружение Тип развертывания с выпуском и сборкой

• ВМ Microsoft Azure • On-Premises: Сборка 2079 или более
поздние версии

• Cloud: Сборка 2079 или более поздние
версии

• Google Compute Engine • On-Premises: Сборка 7103 (A2019.17) or
later

• Виртуальные машины VMware на ESXi 6.x • On-Premises: Сборка 7103 (A2019.17) or
later

• Cloud: Сборка 2079 или более поздние
версии

Microsoft Windows Server 2019 Standard и Datacenter

Окружение Тип развертывания с выпуском и сборкой

• Amazon Web Services Elastic Compute Cloud
(EC2)

• On-Premises: Сборка 1089 или более
поздние версии

• Cloud: Сборка 1082 или более поздние
версии

• Google Compute Engine • On-Premises: Сборка 7103 (A2019.17) or
later

• ВМ Microsoft Azure • On-Premises: Сборка 2079 или более
поздние версии

• Cloud: Сборка 2079 или более поздние
версии

© 2023 Automation Anywhere. All rights reserved.     856



    Automation Anywhere - Install and update Automation 360

Microsoft Windows 10

Окружение Тип развертывания с выпуском и сборкой

• Виртуальные машины VMware на ESXi 6.x • On-Premises: Сборка 7103 (A2019.17) or
later

• Cloud: Сборка 2079 или более поздние
версии

Linux CentOS

Окружение Тип развертывания с выпуском и сборкой

• Amazon Web Services Elastic Compute Cloud
(EC2)

Для Linux CentOS 7.7:
• On-Premises: Начиная с Сборка 2545 или

более поздние версии
• Cloud: Начиная с Сборка 2545 или более

поздние версии

Для Linux CentOS 7.9 и 8.3:
• On-Premises: Начиная с Сборка 9664 или

более поздние версии
• Cloud: Начиная с Сборка 9664 или более

поздние версии

Red Hat Enterprise Linux

Окружение Тип развертывания с выпуском и сборкой

• Amazon Web Services Elastic Compute Cloud
(EC2)

Для Red Hat Enterprise Linux 7.7:
• On-Premises: Начиная с Сборка 2545 или

более поздние версии
• Cloud: Начиная с Сборка 2545 или более

поздние версии

Для Red Hat Enterprise Linux 7.9:
• On-Premises: Начиная с Сборка 9664 или

более поздние версии
• Cloud: Начиная с Сборка 9664 или более

поздние версии
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Amazon Linux 2

Окружение Тип развертывания с выпуском и сборкой

• Amazon Web Services Elastic Compute Cloud
(EC2)

Amazon Linux 2

Ссылки, связанные с данной
Совместимость Bot Agent
Перед установкой Bot Agent убедитесь, что он совместим с аппаратным и программным
обеспечением в вашем окружении.
Control Room server requirements
The Control Room is deployed on servers in data centers. The minimum Automation Anywhere hardware
requirements include server type, machine type, processor, RAM, disk storage, and network requirements.

Supported cloud platforms
Review the supported cloud platforms for various Automation 360 features.

Automation 360 feature Google Cloud
Platform

AWS Microsoft Azure

Control Room Да Да Да

Bot Agent Да Да Да

Bot Insight Да Да Да

IQ Bot Да Да Да

Discovery Bot Да Да Да

AISense Recorder Да Да Да

Credential requirements
Login credentials are required at different stages of Automation 360 deployment and use. Credentials are
required for installation and data center servers, access to Automation 360 components, and to run tools in
боты.

Access point Задача Тип

Data center servers Install Control Room. User on the hosting server:
• Windows - system

 administrator
• Linux - superuser sudo,

root

Data center servers Manage (run, stop, restart)
Control Room.

Administrator and Logon
as Service permission for
Windows services and the
Domain or the VM technical
user account.
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Access point Задача Тип

Устройств: Bot Agent Install, setup, or update Bot
Agent.

Administrator permission on the
device.

Устройств: Bot Agent Start or stop Bot Agent service. Administrator permission on the
device.
Write permission on Bot Agent
device system paths:
C:\ProgramData

C:\Windows
\System32\config
\systemprofile

C:\Users\<loggedInUser>
\AppData\Local
\AutomationAnywhere

Local devices Register device. Windows login to open a
browser and login into the
Control Room and register the
local device.
Administrator permission not
required.

Local devices Download боты to local device.
Run new боты or existing
(downloaded) боты.

Windows login.
Administrator permission not
required.

Automation 360 login Perform specific tasks, such as
create a бот or run a бот.

License and role based
permissions.
Bot Creator and Bot Runner
users do not require
administrator privileges.

Бот task Used by боты to perform бот
tasks.

Credential Vault stores securely
created credentials.
Read permission on бот
machine system path:
C:\Windows
\System32\config
\systemprofile

\AppData\Local
\AutomationAnywhere

Automation Anywhere Service Run all Windows services
created by Automation 360.

Local system account user or
Domain user account
The Interactive logon rights
should be enabled for the
service account.
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Access point Задача Тип

Remote Desktop Protocol (RDP)
to a Windows machine

Run боты on Bot Creator and
unattended Bot Runner if
RDP connection exists for the
deployed user.

Administrator permission is not
required.
RDP access for the бот is not
required.
View the Control Room Activity
page.

Remote Desktop Protocol (RDP)
to a server OS or a hosted VM

Run боты on Bot Creator and
unattended Bot Runner if
RDP connection exists for the
deployed user.

Administrator permission
required.
RDP access for the бот is
required.
For confirmation, view the
Control Room Activity page.

Data center server credentials Data center server credentials for Automation
Anywhere hosting servers and integrated product
servers are required to deploy Automation 360.
To install and deploy Automation 360 requires
that users log in to the hosting servers. These
users must have permissions to install and run
Automation 360 components on the servers.
Permissions levels need to be assigned to the user
on selected data center applications and servers.

Automation 360 login Log in toAutomation 360 requires a username
and password. These credentials are linked to the
machine you use to access the Automation 360
components. Your credentials are assigned roles
that give you permission to perform specific tasks,
such as create a бот or run a бот.

Бот task As an automation expert, Credential Vault
provisions you to securely create and store your
credentials. This ensures that your credentials can
be used in боты without compromising security with
safe deployment of tasks. Any authorized user can
create credentials.

Windows services The Windows service credentials include a user
name and password. The user specified needs to
be:
• A member of the local system administrator

group.
• Have permission to manage services, including

Automation Anywhere services.
• If you use Windows authentication to connect

to the SQL database, ensure you grant the
db_owner permission to the service credential
user.
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The service credentials are used to create database
tables and allow the Control Room processes to
access the database and repository.
The service credential choices are:

User
role

Бот
program
folder

Бот
data
folder

Log
folders
or files

Тип
пользователя

Install
user

• Администратор
• Non-

Admin

Service
run user

• Local
system
account

• Domain
user
account

Бот
deployment
user

• Чтение
• Записать
• Удалить

• Чтение
• Записать
• Удалить

• Чтение
• Записать
• Удалить

• Local
system
account

• Domain
user
account

The following are the different user types:

Администратор A user who has
administrator privileges.

Non-Admin A user who does not
have administrator
privileges.

Local system account The logged-on user
performing the
installation (default).

Domain user account A user that is not the
local system account
user.
Reasons and
requirements for using
a domain account user
include:
• Use the

Windows domain
credentials
Enter credentials
valid for running
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Automation
Anywhere services.

• PowerShell script
restrictions
Specify a user with
permissions to
launch PowerShell
scripts, who is not
a Windows domain
user, or database
table creation can
fail.

Установка Bot Agent и регистрация устройств

Load balancer requirements
View the load balancer requirements for Automation 360 installation. This includes load balancer minimum
requirements, and both TCP and HTTPS layer load balancing requirements.

Load balancer minimum requirements
As a best practice, ensure the load balancer:
• (Required) Adheres to the Domain Name System (DNS) guidelines when configuring the domain and

subdomain URLs in load balancer.
Naming guidelines for Control Room URLs

• (Required) Supports WebSocket protocol (RFC 6455)
• (Preferred) Uses round-robin host selection and is not configured to use persistent (sticky) sessions.
• (Preferred) Uses the appropriate TLS security layer:

• TCP (layer 4) load balancing
• HTTPS (layer 7) load balancing

With a Nginx load balancer, set HTTPS termination at nodes by changing http://Backend to
https://Backend.

• (Preferred) Has idle timeout set to 120 seconds.
The timeout value depends on the process time of various actions in the Control Room such as the time
required to check in and check out боты, import боты, and download бот dependencies.
If the idle timeout is less than the Control Room processing time, a browser request can time out. For
example, if the configured idle timeout is not sufficient to complete a бот check-in action, you will have
to refresh your browser to validate whether the бот check-in action is successful or not.

Load balancer health check parameters

The load balancer health check parameters depend on various factors such as the type of load balancer
used, network latency, and user interface responsiveness within and outside the load balancer.
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TCP (Layer 4) Load Balancing

When TCP is applied at layer 4 with the load balancer, the certificate is installed on every Control Room
corresponding to the load balancer URL.

In the image, Control Room components are shown in orange and other components are shown in blue.

Pros End-to-end encryption without the possibility of
intercept at the load balancer.
Single certificate required.

Cons If audit logging is required, the load balancer
cannot report the requests from clients.
Does not use TLS hardware offloading, even if the
load balancer supports it.

HTTPS (Layer 7) Load balancing

When HTTPS is applied at layer 7 with the load balancer, the certificate corresponding to the load balancer
URL is applied through the load balancer. The Control Room trusts the certificates received from the load
balancer.
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Pros Allows request logging, when supported by the load
balancer.
Reduces load from TLS handshake through
hardware offloading, when supported by the load
balancer.

Cons Certificates must be managed both on the load
balancer and on the control room nodes
Possible interception of data at the load balancer
hardware level, because TLS session is not end-to-
end.

For Automation 360 users on release Сборка 7560 and later, if SSL offloading is applied at load balancer
level for communication between load balancer and application nodes, the traefik.toml file in
application server needs to be re-configured.
See SSL offloading for Automation 360 v.18 and later (A-people login required) | A360 | Device shows disconnected
after registration with Load Balancer URL (A-People login required)

Требования к портам, протоколам и брандмауэру
Просмотрите требования по умолчанию и настраиваемые требования к брандмауэру, портам и
протоколам для развертывания Automation Anywhere. View the default ports and protocols that are
required to be allowed on customer's firewall for Automation Anywhere deployment. The default ports that
are used for HTTP/HTTPS are configurable.
• Добавьте Automation Anywhere в список исключений брандмауэра Windows. Выполните действия,

рекомендуемые корпорацией Microsoft для вашей версии Windows.
• Allow communication from Automation Anywhere by adding it to the allowed list in firewall. Follow the

steps in the firewall documentation of the operating system.
• Настройте правила брандмауэра и добавьте URL-адреса Control Room в список безопасных

получателей.
• Configure the firewall rules to allow communication on the server or the firewall appliances that are

configured in between, or add the Control Room URLs to the safe recipients list in firewall or end device
browsers.
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Списки необходимых портов и их использование см. в следующих таблицах.

Control Room

Важное замечание:  Важно, чтобы связь между серверами Control Room была должным образом
защищена. The communication between Control Room servers contain security sensitive information.
Therefore, in addition to allowing all the required communication directly between the Control Room
cluster servers, you should block all the inbound traffic from hosts except for HTTP/HTTPS ports to
communicate with the Control Room servers.

Протокол Порт Использование Клиенты

HTTP 80 HTTP Веб-браузеры

HTTPS 443
HTTPS и
Веб-сокет

Веб-браузеры

TCP/UDP 1234 ActiveMQ Службы Automation 360

TCP 5672 Обмен сообщениями в
кластере Службы Automation 360

TCP 47100–47200
Обмен сообщениями
и кэширование в
кластере

Службы Automation 360

TCP 47500–47598
Обмен сообщениями
и кэширование в
кластере

Службы Automation 360

HTTP 47599 Elasticsearch Службы Automation 360

TCP 47600 Elasticsearch Службы Automation 360

HTTP 4567 Control Room Службы Automation 360

HTTP 4569–4571 Automation Anywhere
Robotic Interface

Службы Automation 360

TCP 5800–5900 Automation Anywhere
Robotic Interface

Службы Automation 360

Внутренние порты для служб localhost

Обратите внимание, что следующие внутренние порты используются для служб localhost в
Automation 360:

Порт Протокол

4567–4571 HTTPS REST

5678–5707 gRPC
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Порты и протоколы центров обработки данных для Automation 360

Настройте все компоненты центра обработки данных, которые необходимы для интеграции
Control Room. На изображении ниже компоненты Control Room показаны оранжевым цветом, а
предоставленные вашей организацией компоненты центра обработки данных — синим.

Прим.:  The arrows in the image indicates the combination of communicating hosts and does not indicate
the direction of the establishing the connection.
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Списки портов по умолчанию показаны в целях иллюстрации. Некоторые порты могут иметь
альтернативные номера портов, указанные во время установки Control Room. Некоторые номера
портов можно изменить после установки Control Room. Порты Active Directory приведены в качестве
примера управления корпоративными удостоверениями.
After the HTTP/HTTPS connection is established between the Control Room and Bot Agent, the
communication will be bidirectional (inbound and outbound) using the WebSocket .
Все три объекта (веб-браузер, Bot Agent и внешние приложения) напрямую взаимодействуют
с Control Room. Пользователь выполняет вход в Control Room через браузер, чтобы выполнить
задачи, например создать пользователей, или связанные с бот задачи (создание, развертывание
и планирование боты). Bot Agent устанавливает подключение с Control Room при регистрации и
сохраняет его, чтобы развертывать бот из Control Room. Внешние приложения взаимодействуют
с Control Room напрямую через API Control Room для выполнения таких задач, как создание
пользователей или запуск боты.

Connection from Connection to Протокол Порт Использование

Bot Agent Load balancer or
firewall, or both

HTTP and
WebSocket

80 (TCP) Default HTTP and
WebSocket

Bot Agent Load balancer or
firewall, or both

HTTP and
WebSocket

443 (TCP) HTTP and
WebSocket

Web Browser Load balancer or
firewall, or both

HTTP and
WebSocket

80 (TCP) HTTP and
WebSocket

Web Browser Load balancer or
firewall, or both

HTTP and
WebSocket

443 (TCP) HTTP and
WebSocket

LDAP 389 (TCP) User
authentication

LDAP SSL 636 (TCP) User
authentication

LDAP global
controller

3268 (TCP) User
authentication

LDAP global
controller SSL

3269 (TCP) User
authentication

Control Room
services

Enterprise identity
management (for
example, Active
Directory)

Kerberos 88 (TCP and UDP) User
authentication

Control Room
services

File share with
Microsoft Server
Message Block
(SMB)

SMB 2.0 or SMB
3.0

445 (TCP) Repository file
share access

Control Room
services

Сервер базы
данных Microsoft
SQL

SQL 1433 (TCP)
Configurable

Database access
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Элементы центра обработки данных, поддерживаемые Microsoft Azure

Объект центра обработки
данных

Поддерживаемая версия Конфигурация

Операционная система Control
Room

• Microsoft Windows
Server 2012 и 2012 R2
Datacenter

• Microsoft Windows
Server 2016 Standard и
Datacenter

• Microsoft Windows
Server 2019 Standard и
Datacenter

IaaS

Управление удостоверениями:
Azure Active Directory

Azure Active Directory • IDaaS
• Windows 2016 для IaaS

SMB File Share Azure File Share с протоколом
Server Message Block 2.0 и 3.0
(SMB)

PaaS

Load Balancer Балансировщик нагрузки
Azure (не шлюз приложений)

PaaS

Microsoft SQL Server База данных Azure SQL с
отдельной базой данных
(Microsoft SQL Azure (RTM) —
12.0.2000.8)

PaaS

Рекомендуемые порты политики безопасности Microsoft Azure

Объект центра обработки
данных

Порт Протокол

Control Room • 80
• 443

HTTP/HTTPS

LDAP • 3268
• 3269

TCP (LDAPS - Secure TCP)

эл. почта SMTP 587 SMTP

SSH 22 TCP

RDP 3389 TCP
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Рекомендуемые порты политики безопасности Google Cloud Platform

Объект центра обработки
данных

Порт Протокол

Балансировщик нагрузки • 80
• 443

• HTTP
• HTTPS

Брандмауэр • 80
• 443
• 1433

• HTTP
• HTTPS
• TCP

База данных Microsoft SQL
Server

1433 TCP

Задачи, связанные с данной
Prepare for installation on Amazon Web Services
Use these steps to prepare the Amazon Web Services (AWS) instances for the Control Room installation.
Verify readiness for installation on Microsoft Azure
Use these steps to configure third-party products for the Control Room installation.
Ссылки, связанные с данной
Automation 360 On-Premises prerequisites
Determine whether the system has the required hardware and software to install Control Room for
Automation 360 On-Premises.
Add Automation 360 Cloud URLs to trusted list
To ensure secure access to Automation 360 cloud services, add the URL specific to the service to the safe
recipients or trusted list.

Control Room repository requirements
The repository location is configured in the Control Room after installation. All your automations are stored
in this repository.
Before you configure the Control Room server repository, review the repository requirements for deploying
Automation 360 On-Premises.
• For a single node Control Room deployment, the repository can be a local folder.

For example, C:\Automation360\Automation Anywhere Server Files.
• For a multiple-node Control Room deployment, the repository should be accessible from all Control

Room nodes in the cluster over the network.
You can create a file share and access the repository from a local machine. For example, \
\<fileserver>\\<folder>\\Automation Anywhere Server Files.

The Control Room repository contains server files, such as packages and resource files.

Прим.:  Deploying Distributed File System (DFS) as a Control Room repository is not supported.
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Microsoft Windows: Control Room repository requirements

Review the following requirements for configuring the repository location of cluster nodes:
• The Control Room uses its service account to connect to the repository, you must have read/write

permission to the repository location.
• The repository path must meet the Universal Naming Convention (UNC) requirements.

Подробнее см. в разделе UNC Path.
• The repository size depends on the user data.

For details about storage requirements, see Control Room server requirements. For supported file and
folder size, see Одновременные развертывания и выполнения бот.
For repository migration requirements, contact your Automation Anywhere representative.

• You can configure the repository using Network File System (NFS) protocols, such as Microsoft
Windows, Microsoft Azure Files, and Amazon Elastic File System (EFS).

• Network-attached storage (NAS) uses Server Message Block version 3 (SMBv3) for supported platforms:
Microsoft Windows, Amazon Web Services, Microsoft Azure, Google Cloud Platform, and Linux.

Linux: Control Room configuration using the default repository path

• Ensure that the default path exists in the system and use this default path during the Linux installation.
After the installation, you can modify the repository path or copy files from one directory to another.
Verify that all copied files and folders have the same permissions as before the installation.

• Ensure that permission for the path is crkernel:controloroom.
• If there is no permission, add the following permission.

sudo chmod -R 775 /opt/automationanywhere/enterprise/appdata 

• Run the following command to allow users access to the crkernel:controloroom path:

sudo chown -R crkernel:controlroom /opt/automationanywhere/enterprise/
appdata

Linux: Control Room configuration with a user-defined repository path

• Ensure that the default path exists in the system.
• Ensure that permission for the path is crkernel:controloroom.
• If there is no permission, add the following permission.

sudo chmod -R 775 /CRRepo/AutomationAnywhere

• Run the command to allow users access the crkernel:controloroom path:

sudo chown -R crkernel:controlroom /CRRepo/AutomationAnywhere

The crkernel:controloroom user is created after the Control Room installation, so set the user
permission to a specified repository before performing the final Control Room configuration.
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Требования к браузеру для доступа к Рабочая область RPA
Доступ к интерфейсу Рабочая область RPA из браузера. After you have installed and enabled
extensions in the browser, perform several tasks through the Рабочая область RPA interface based on
your user role and automation requirements.

Важное замечание:  Поскольку в июне 2022 года наступает конец срока службы (EOL) Microsoft
Internet Explorer 11, Control Room не будет поддерживаться в браузере Microsoft Internet Explorer 11,
начиная с предстоящего выпуска Automation 360 v.25, запланированного на текущий год (июнь
2022 года).
Влияние на автоматизацию зависит от операционной системы, которая в настоящее время
используется для развертывания ваших бот. Подробные сведения см. в следующей таблице.

Операционная система Microsoft Automation 360

Лицензия Windows 10 Semi-Annual Channel Обновите боты, чтобы использовать другой
совместимый браузер.

Поддерживаемые браузеры

Все другие поддерживаемые операционные
системы

Совместимость Bot Agent

Действия не требуются.

Подробнее см. в разделе Microsoft Internet Explorer 11 EOL FAQ.

Поддерживаемые браузеры

Вы можете использовать браузер для выполнения ряда задач — от создания автоматизации до
управления автоматизацией, например, таких:
• Действия Control Room, такие как создание пользователей и ролей, управление устройствами,

настройка параметров, создание и развертывание боты и ведение журналов аудита.
• Действия пользователя, такие как установка Bot Agent и регистрация устройств.
• Действия Automation Anywhere Robotic Interface, такие как создание пользователей и ролей, а

также создание задач для человека и бот в редакторе процессов.

Поддержка браузеров для Control Room,
Bot Agent и Automation Anywhere Robotic
Interface

В представленной ниже таблице приведены
поддерживаемые браузеры для видов действий
Control Room, установки Bot Agent, Automation
Anywhere Robotic Interface и регистрации
устройств.
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ДействияGoogle
Chrome
(версия 57
или
более
поздняя)

Internet
Explorer
(версия 11)

Microsoft
Edge
на
основе
Chromium
(версия 93.0.961.52
или
более
поздняя)

Mozilla
Firefox
(версия 80
или
более
поздняя)

Safari
(версия 15.3
или
более
поздняя)

Действия
Control
Room

Да Нет Да Нет Нет

Установка
Bot
Agent
и
регистрация
устройств1

Да Нет Да3 Да Нет

Automation
Anywhere
remote
agent
for
Citrix

Да2 Да Нет Нет Нет

Automation
Anywhere
Robotic
Interface

Да Нет Да Нет Да

Bot
Insight

Да Нет Да Да Нет

1. Если у вас возникли проблемы с
регистрацией устройства из браузера,
запустите утилиту диагностики Bot Agent.
Подробнее см. в разделе Выполнение
диагностических проверок Bot Agent

2. Automation Anywhere remote agent for
Citrix поддерживает автоматизацию Google
Chrome (XenApp) с расширением Automation
Anywhere (версия 11.2.0.0).
Chrome web store

3. If you are using Microsoft Edge based on
Chromium to register your Bot Agent and
your device is unable to connect to the
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Control Room due to proxy settings, add the
authentication details.

Поддержка браузера для записи
автоматизации

В представленной ниже таблице приведены
поддерживаемые браузеры для записи
автоматизации.

ДействияGoogle
Chrome
(версия 57
или
более
поздняя)

Internet
Explorer
(версия 11)

Microsoft
Edge
на
основе
Chromium
(версия 79
или
более
поздняя)

Mozilla
Firefox
(версия 80
или
более
поздняя)

Microsoft
Edge
(Chromium)
с
совместимостью
с
Internet
Explorer
(версия
93.0.961.52
или
более
поздняя)

Запись
автоматизации
1

Да
• Для

записи
должно
быть
включено
расширение.

• Поддерживается
с
A2019 v.10.

Да
• Для

записи
не
требуется
расширение.

• Поддерживается
с
версии
A2019.06.

Да
• Для

записи
должно
быть
включено
расширение.

• Поддерживается
с
A2019 v.17.

Да
• Для

записи
должно
быть
включено
расширение.

• Поддерживается
с
A2019 v.19.

Да2

• Для
записи
должен
быть
включен
режим
совместимости
с
Internet
Explorer.

• Поддерживается
с
Automation
360 v.23.

1. Запись автоматизации означает открытие
целевого приложения для записи в
поддерживаемом браузере и запись
действий или создание снимков объектов
с помощью средств записи Automation
Anywhere.
• Для получения подробной информации

об автоматизации с использованием
действий создания снимков Universal
Recorder и Средство записи см. Universal
Recorder for object-based automation | Edit a
task recorded with the Universal Recorder

• Если у вас возникли проблемы с
автоматизацией записи с помощью
Google Chrome, см. раздел Google Chrome
extension troubleshooting
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2. Microsoft Edge (Chromium) с режимом
совместимости с Internet Explorer
поддерживается для создания снимков
объектов из веб-приложений, основанных на
технологии HTML.

Расширения для автоматизации

Когда вы устанавливаете Bot Agent из браузера, устанавливаются расширения для Automation 360.
Для записи автоматизации с помощью поддерживаемого браузера необходимы расширения.
Вы можете включить расширения на устройстве можно с помощью поддерживаемых браузеров.
Например, после установки Bot Agent из браузера Google Chrome щелкните параметр включения
расширения на панели задач браузера. Расширение Google Chrome позволит вам записывать
автоматизацию с использованием браузера Google Chrome.
Когда вы подключаете устройство Bot Agent к Control Room, вы можете включить указанные ниже
расширения браузера для записи автоматизации.

Имя расширения Ссылка на расширение

Google Chrome Automation 360 extension for Chrome

Microsoft Edge на основе Chromium Automation 360 extension for Microsoft Edge

Mozilla Firefox Automation 360 extension for Mozilla Firefox

Информацию об обновлении расширения до последней версии см. в разделе Browser extensions for
Automation 360

Задачи, связанные с данной
Выполнение диагностических проверок Bot Agent
Используйте утилиту диагностики Bot Agent для решения проблем, связанных с подключением
между устройством Bot Runner и Control Room. Утилита помогает диагностировать проблемы,
предоставляя решения или предложения по их устранению.
Ссылки, связанные с данной
Universal Recorder supported applications and browsers
Use the Universal Recorder to record interactions with objects from the supported technologies.
Совместимость Bot Agent
Перед установкой Bot Agent убедитесь, что он совместим с аппаратным и программным
обеспечением в вашем окружении.
Google Chrome extension troubleshooting
If you encounter an error when recording or running a бот that automates tasks in a Google Chrome
browser and you have installed Google Chrome, you must perform additional steps to configure your
system.
Browser extensions for Automation 360
Создавайте автоматизацию из поддерживаемых браузеров с помощью расширений браузера.
Расширения периодически обновляются для поддержки улучшений и исправлений функций.
Поэтому убедитесь, что у вас установлены последние версии расширений для браузеров Google
Chrome, Microsoft Edge и Mozilla Firefox.

© 2023 Automation Anywhere. All rights reserved.     875

https://chrome.google.com/webstore/detail/automation-360/kammdlphdfejlopponbapgpbgakimokm
https://microsoftedge.microsoft.com/addons/detail/automation-360/dbmodiepejcigljbmeebedkmegndokbk
https://addons.mozilla.org/en-US/firefox/addon/automation-anywhere-a2019


    Automation Anywhere - Install and update Automation 360

Интернационализация, локализация и поддержка языков
Automation 360 обеспечивает поддержку интернационализации и локализации пользовательского
интерфейса (UI), автоматизации и документации.
Интернационализация означает, что вы можете автоматизировать операции с использованием
поддерживаемых языков. Локализация означает, что пользовательские интерфейсы переведены
на языки, поддерживаемые в Automation Anywhere. Кроме того, эти поддерживаемые языки
протестированы и сертифицированы для работы.

Интернационализация Выполняйте автоматизацию на различных
языках для работы с локализованными
операционными системами и клавиатурами.

Формат кодировка UTF-8 — формат кодировки по умолчанию для
Automation 360.

Документация продукта Просмотрите документацию Automation
Anywhere на поддерживаемом языке в https://
docs.automationanywhere.com/. Чтобы просмотреть
информацию на одном из поддерживаемых
языков, выберите язык из выпадающего
меню в правом верхнем углу страницы сайта.
Английский используются в качестве языка по
умолчанию для любой темы, которая недоступна
на другом языке.

Интерфейс Используйте пользовательский интерфейс для
Automation 360, включая Control Room и IQ Bot,
на поддерживаемом языке.
• Автоматизируйте приложения

(веб-приложения и настольные) с помощью
языкового пользовательского интерфейса,
текста и значений элементов управления
(например, кнопка с названием языка и
комбинированные управляющие элементы с
текстом на соответствующем языке).

• Укажите название языка для бота, потока
операций и отчета в Control Room.

• Укажите название языка для расписаний
бот, имени и описания автоматизации,
имени и описания роли, имени и фамилии
пользователя, пулов рабочих нагрузок и
очередей.

• Разверните боты с названием языка на Bot
Runner.

• Просматривайте языковые объекты
(названия, описание и т. д.) на всех
страницах в Control Room.

Выбор языка в пользовательском
интерфейсе

В интерфейсе Control Room рядом с
идентификатором пользователя щелкните
значок языка (значок глобуса) и выберите язык
из списка.

Переводимые части интерфейсов Control Room не включают приложения или инструменты, которые
используются в боты. Например, Microsoft Excel не переводится посредством Control Room.
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Automation 360

Прим.:  Языковая настройка Control Room не означает перевод языка в Bot Insight из-за разницы в
приложениях. Для альтернативных языков в Bot Insight пользователи должны искать перевод либо
в языковых параметрах браузера, либо в операционной системе, настроенной на выбранный ими
язык.

Язык Интернационализация
(операционная
система и набор
символов)

Локализация
(пользовательский
интерфейс)

Документация
продукта

Арабский Доступно Недоступно Недоступно

Китайский
(упрощенное письмо)

Доступно Доступно Доступно

Китайский
(традиционное
письмо)

Доступно Доступно Доступно

Датский Доступно Недоступно Недоступно

Нидерландский
(Нидерланды)

Доступно Недоступно Недоступно

Французский Доступно Доступно Доступно

Немецкий Доступно Доступно Доступно

Иврит Доступно Недоступно Недоступно

Венгерский Доступно Недоступно Недоступно

Итальянский Доступно Доступно Доступно

Японский Доступно Доступно Доступно

Корейский Доступно Доступно Доступно

Польский Доступно Недоступно Недоступно

Португальский
(Бразилия)

Available Available Available

Russian Available Available Available

Испанский Доступно Доступно Доступно

Шведский Available Недоступно Недоступно

Turkish Available Недоступно Недоступно
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Automation 360 IQ Bot

Язык Интернационализация
(операционная
система и набор
символов)

Локализация
(пользовательский
интерфейс)

Документация
продукта

Арабский Доступно Недоступно Недоступно

Китайский
(упрощенное и
традиционное письмо)

Доступно Доступно Доступно

Французский Доступно Доступно Доступно

Немецкий Доступно Доступно Доступно

Итальянский Доступно Доступно Доступно

Японский Доступно Доступно Доступно

Корейский Доступно Доступно Доступно

Португальский
(Бразилия)

Available Available Available

Russian Available Available Available

Испанский Доступно Доступно Available

Components for Control Room and бот actions
Control Room and боты have additional requirements depending upon the Automation 360 deployment
model you choose. Some third party applications are installed with Automation 360.

Control Room supported platforms

View the listed supported platforms and components for Control Room.

Component Supported Control Room option

Amazon Web Services Elastic Compute Cloud
(EC2)

Required to install Control Room platform.

HTML Required for Microsoft Azure: Use Load Balancer,
not Application Gateway.

Java Database Connectivity (JBDC) driver Required for Oracle Database.

Linux CentOS or Red Hat Enterprise Linux Python 3.6 required for Сборка 6463 and later.
Install Control Room platform.

Microsoft Active Directory Required to configure as either IDaaS or IaaS.
For IaaS use Windows 2016.

Microsoft Azure Required to install Control Room platform.
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Third-party components for бот actions

View the listed third party components for the бот actions.

Component Automation 360 Plug-in Supported Бот action

ABBYY FineReader Engine
version 12.2.27.12

Required for capturing images
in the Распознавание текста
(OCR), AISense, and IQ Bot
packages.

Citrix Receiver
Version 4.4 LTSR or later

Прим.:  You can also use the
Citrix Workspace app. All major
releases of the Citrix Workspace
app version .22 are certified.

Automation 360 Citrix remote
agent

Prerequisite for бот actions on
the Bot Agentinstalled on Citrix
resident apps.

Citrix Virtual Apps version 6.5 or
later

Automation 360 Citrix remote
agent

Prerequisite for бот actions on
business applications hosted
on Citrix server resident apps.
Supported with Universal
Recorder.

IBM WebSEAL For reverse proxy for Bot
Runner.

Microsoft .NET Framework
version 4.6.1 or later

For the Recorder package.

Supported special characters
Use only supported special characters when creating user names and passwords. Supported characters
vary depending upon where they are used.
In all of the below listed cases, the standard alphanumeric characters, a-z, A-Z, 0-9 are supported.
The special characters allowed or specifically excluded from particular use are typical to standard English
keyboards. See the table below to verify the special characters that can be used in names or passwords.

TLS certificate Do not use at sign ( @ ) in passwords
Wildcards The asterisk ( * ) is supported.
Окна Do not use the pipe ( | ) or semicolon ( ; ) in user

names or passwords.
Worksheet Do not use the asterisk ( * ), question mark ( ? ),

or bracket left or right ( [ ] ) in the worksheet
name.

База данных Do not use percent ( % ) or space ( ) in the
database name.
Do not use semicolon ( ; ) in the database
username or password.
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Supported characters

Characters supported for authentication are acceptable for both user names and passwords. In the table:
• Supported means the character is explicitly supported for that use.
• Do not use means the character is explicitly not supported for that use.
• Double dash (--) means results with using the character for that use are unknown.

Character Аутентификация
Windows

Control Room
authentication

Database name,
username, or
password

JSON Web Token
authentication

ampersand ( & ) Supported Supported -- Supported

angle bracket, left
or right ( < > )

Supported -- -- --

apostrophe,
straight single ( ' )

Supported -- -- --

asterisk ( * ) Supported -- -- --

at sign ( @ ) Supported Supported -- Supported

braces left or right
( { } )

Supported -- -- --

bracket left or
right ( [ ] )

Supported -- -- --

caret ( ^ ) Supported -- -- --

colon ( : ) Supported -- -- --

dollar sign ( $ ) Supported Supported -- Supported

equal sign ( = ) Supported -- -- --

exclamation point
( ! )

Supported Supported -- Supported

hyphen ( - ) Supported Supported Supported Supported

parenthesis, left or
right ( ( ) )

Supported -- -- --

percent ( % ) Supported Supported Do not use Supported

period ( . ) Supported Supported Supported Supported

pipe ( | ) Do not use -- -- --

plus sign ( + ) Supported -- -- --

number sign ( # ) Supported Supported -- Supported

question mark
( ? )

Supported -- -- --

semicolon ( ; ) Do not use -- Do not use --

slash, forward or
backward ( / \ )

Supported -- -- --
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Character Аутентификация
Windows

Control Room
authentication

Database name,
username, or
password

JSON Web Token
authentication

space Supported -- Do not use --

underscore ( _ ) Supported Supported Supported Supported

Citrix integration on Cloud
Automation 360 integration with Citrix enables you to create боты that run tasks on remote Citrix Virtual
Apps servers.

Process overview

Ensure the following tasks are completed before you begin automating tasks in a Citrix environment:

Verify the Citrix component version Following are the various Citrix components and
its related versions that are supported for the
Automation 360 integration with Citrix.

Citrix
component
version

Automation
Anywhere
Plug-in

Automation
360 client or
Bot option

Citrix Receiver
Version 4.4
LTSR or later

Прим.:  You
can also use
the Citrix
Workspace
app. All major
releases of
the Citrix
Workspace app
version .22 are
certified.

For using
Citrix server
resident apps
or installing
Automation
360 client.

Citrix Virtual
Apps version
6.5 or later

For using Citrix
server resident
apps.

Citrix
XenDesktop
Version 7.15
LTSR

Automation
Anywhere
Citrix plug-in
Automation
Anywhere
Citrix remote
agent

For using
Citrix server
resident apps
or installing
Automation
360 client.
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Verify credentials and licensing • Ensure you have the credentials to access the
Citrix server.

Прим.:  We recommend you have different
Citrix login credentials for each Bot Runner user.

• Ensure the appropriate Citrix license is available
for the Automation Anywhere Enterprise system.

Install components Specific Citrix and Automation Anywhere
components are required on both the local user
machine and the Citrix Virtual Apps server.

Local machine 1. Install Citrix
Receiver.

2. Install the Bot
Agent. This is
automatically
installed when you
register the local
machine with the
Control Room.
The Bot Agent
and Automation
Anywhere plug-
in for Citrix are
installed at the
same time if the
Citrix Receiver is
installed on the
local machine.

3. Install the
Automation
Anywhere plug-in
for Citrix.
If the Bot Agent is
already installed,
the Automation
Anywhere plug-
in for Citrix is
automatically
installed when the
Universal Recorder
is initiated.

Citrix server 1. Install the
Automation
Anywhere remote
agent for Citrix.

2. Register the
Automation
Anywhere remote
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agent for Citrix as
a Virtual App in the
Citrix StoreFront.

Create a бот 1. From the Citrix StoreFront, run the
AARemoteAgent and the target application.

2. From the Control Room, create the бот, start
the Recorder, select the target application,
and record your actions on the Citrix server to
build your бот.

Using Citrix architecture with боты

To create and run боты using applications that reside on a Citrix server, see the following resources:

Using the Recorder on Citrix Virtual Apps servers The Record: Capture cloning action requires
specific configurations to capture objects from
applications available through the Citrix StoreFront
on a remote Citrix Virtual Apps server. Ensure the
required components are installed on the local
machine and the remote Citrix Virtual Apps server.

Понятия, связанные с данным
Installing Automation Anywhere remote agent on Citrix servers
Install the Automation Anywhere remote agent on the Citrix Virtual Apps server where the virtualized
applications are installed.
Задачи, связанные с данной
Using the Recorder on Citrix Virtual Apps servers
The Record: Capture cloning action requires specific configurations to capture objects from applications
available through the Citrix StoreFront on a remote Citrix Virtual Apps server. Ensure the required
components are installed on the local machine and the remote Citrix Virtual Apps server.
Installing the Citrix required components on local machines
Install the Automation Anywhere components to enable you to use боты on Citrix Virtual Apps servers.
Two components are installed: Bot Agent and Automation Anywhere plug-in for Citrix.
Ссылки, связанные с данной
Требования к браузеру для доступа к Рабочая область RPA
Доступ к интерфейсу Рабочая область RPA из браузера. After you have installed and enabled
extensions in the browser, perform several tasks through the Рабочая область RPA interface based on
your user role and automation requirements.

Using the Recorder on Citrix Virtual Apps servers
The Record: Capture cloning action requires specific configurations to capture objects from applications
available through the Citrix StoreFront on a remote Citrix Virtual Apps server. Ensure the required
components are installed on the local machine and the remote Citrix Virtual Apps server.
Complete the steps listed in the following tasks:
• Installing the Citrix required components on local machines
• Installing Automation Anywhere remote agent on Citrix servers
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If you are using Google Chrome for automation, ensure the Automation Anywhere extension (version
11.2.0.0) for Automation Anywhere remote agent for Citrix is installed and enabled. For Automation 360
remote agent, ensure that the Automation Anywhere extension (version 3.0.0.0 or later) is installed and
enabled.
Chrome web store

Create боты with applications running on a remote Citrix Virtual Apps server using the Automation
Anywhere remote agent for Citrix.
1. Log in to the Citrix Virtual Apps server StoreFront.

Прим.:  You can also use the Citrix Workspace app. All major releases of the Citrix Workspace app
version .22 are certified.

2. Depending on the Automation 360 release, select and run one of the following remote agents from the
Citrix StoreFront.
• Select Citrix server > Citrix StoreFront > AARemoteAgent.

Прим.:  AARemoteAgent is the Citrix name for the Automation Anywhere remote agent for
Citrix.

• Select Citrix server > Citrix StoreFront > A360 Remote agent.

Прим.:  A360 Remote agent is the Citrix name for the Automation 360 remote agent.

3. Run the target application from the Citrix StoreFront.
4. Log in to your registered local machine with the Bot Agent and Citrix Receiver installed.
5. Log in to the Control Room from your registered local machine.
6. Create a new бот or edit an existing бот.
7. Select the auto login feature to log in to a Citrix environment when it is locked or logged off.

Прим.:  To ensure the auto login works, always log off the Citrix Receiver associated with the Citrix
Virtual Apps server before you disconnect.

8. Start the Recorder.
9. From the Automation Anywhere Record Application selection window, select the target

application from the drop-down list in the Window or URL field, and click Start recording.

Прим.:  The remote application has \\Remote label at the end of the application name.

10. When the steps to record are completed, click End recording.

Понятия, связанные с данным
Citrix integration on Cloud
Automation 360 integration with Citrix enables you to create боты that run tasks on remote Citrix Virtual
Apps servers.
Installing Automation Anywhere remote agent on Citrix servers
Install the Automation Anywhere remote agent on the Citrix Virtual Apps server where the virtualized
applications are installed.
Задачи, связанные с данной
Installing the Citrix required components on local machines
Install the Automation Anywhere components to enable you to use боты on Citrix Virtual Apps servers.
Two components are installed: Bot Agent and Automation Anywhere plug-in for Citrix.
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Ссылки, связанные с данной
Требования к браузеру для доступа к Рабочая область RPA
Доступ к интерфейсу Рабочая область RPA из браузера. After you have installed and enabled
extensions in the browser, perform several tasks through the Рабочая область RPA interface based on
your user role and automation requirements.

Using Citrix XenDesktop on Cloud
Install the Bot Agent on a Citrix XenDesktop virtual machine to create or run боты using applications that
reside on that Citrix XenDesktop virtual machine.
Ensure the required components are installed on the local Bot Agent machine and the remote Citrix server.
The required components are:

On the local machine Citrix Receiver. Install this on every machine you
use to connect to a Citrix server.

Прим.:  You can also use the Citrix Workspace
app. All major releases of the Citrix Workspace app
version .22 are certified.

On the Citrix XenDesktop Bot Agent. Install this on the Citrix XenDesktop
virtual desktop.
Log in to the Control Room and launch the recorder.
This triggers the Bot Agent installer.
The Citrix XenDesktop is a virtual machine sitting on
a remote Citrix server. It contains the applications
to be used for the боты.

The following figure shows the process flow when the Bot Agent is installed on a Citrix XenDesktop with
the applications on the virtual desktop.
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The Bot Agent can be installed on multiple platforms, which includes a Citrix XenDesktop virtual machine.
Ensure the virtual desktop meets the requirements for any Bot Agent installation.
Create боты with Citrix XenDesktop.
1. Prepare for бот activities.

a) Install the Citrix Receiver on your local machine.
b) Install the Bot Agent on Citrix XenDesktop.

2. From your local machine with Citrix Receiver installed, log in and open Citrix server > Citrix
StoreFront.

3. Select the Citrix XenDesktop virtual desktop with the Bot Agent.
The whole Citrix XenDesktop is presented as a local virtual desktop on your local machine. This is
automatic when you start the Citrix XenDesktop.

4. From the virtual desktop, launch the Enterprise Client that is installed on the Citrix XenDesktop, or
launch a browser and log in to the Control Room.
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5. From your Control Room, create the бот.

Installing the Citrix required components on local machines
Install the Automation Anywhere components to enable you to use боты on Citrix Virtual Apps servers.
Two components are installed: Bot Agent and Automation Anywhere plug-in for Citrix.

1. Log in to your local machine.
2. Install Citrix Receiver.

Прим.:  You can also use the Citrix Workspace app. All major releases of the Citrix Workspace app
version .22 are certified.

This Citrix component is required to communicate from a local machine to a Citrix virtual application
server.
To install the Citrix Receiver, see the Citrix documentation.

3. Register your local machine with the Control Room. This installs the Bot Agent.
The Bot Agent enables local machine communication with the Control Room.
To install the Bot Agent:
a) Войдите в Control Room с использованием URL-адреса Automation Anywhere.
b) Navigate to Devices in the Manage tab.
c) From the action icons, click Add local bot agent.
d) Щелкните Подключиться к моему компьютеру.
e) Выполните шаги, описанные в мастере.
f) Обновите страницу Устройства и убедитесь, что локальное устройство добавлено.

4. Install Automation Anywhere plug-in for Citrix on your local machine.
The Automation Anywhere plug-in for Citrix provides the Citrix driver. This driver communicates with
the Citrix server.
To install the Automation Anywhere plug-in for Citrix:
a) Войдите в Control Room.
b) Launch one of the designated events.

Designated events include: launch Recorder, use the Devices tab or Device Status tab, or run
a бот from Editor.

c) Необязательно: Verify that the Automation Anywhere plug-in for Citrix is installed.
Check for the file C:\Program Files (x86)\Citrix\ICA Client
\Automation.CitrixDriver.dll.

Понятия, связанные с данным
Citrix integration on Cloud
Automation 360 integration with Citrix enables you to create боты that run tasks on remote Citrix Virtual
Apps servers.
Installing Automation Anywhere remote agent on Citrix servers
Install the Automation Anywhere remote agent on the Citrix Virtual Apps server where the virtualized
applications are installed.
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Задачи, связанные с данной
Using the Recorder on Citrix Virtual Apps servers
The Record: Capture cloning action requires specific configurations to capture objects from applications
available through the Citrix StoreFront on a remote Citrix Virtual Apps server. Ensure the required
components are installed on the local machine and the remote Citrix Virtual Apps server.

Installing Automation Anywhere remote agent on Citrix servers
Install the Automation Anywhere remote agent on the Citrix Virtual Apps server where the virtualized
applications are installed.
Based on the version of the Средство записи пакет that you are using, choose the appropriate remote
agent for your environment:
• For bots that use 2.8.6-20220823-160834 version of the Средство записи пакет, install the new

Automation Anywhere remote agent for Citrix 2.0 available with Build v 2.0.0.7. For details on installing
the Automation Anywhere remote agent for Citrix 2.0, see Install Automation Anywhere remote agent for
Citrix 2.0: Средство записи пакет version 2.8.6

• For bots that use 2.7.3-20220527-004608 or earlier version of the Средство записи пакет, install the
Automation Anywhere remote agent for Citrix 1.0 available with Build v 1.0.0.0. For details on installing
the Automation Anywhere remote agent for Citrix 1.0, see Install Automation Anywhere remote agent for
Citrix 1.0: Средство записи пакет version 2.7.3 and earlier

Понятия, связанные с данным
Citrix integration on Cloud
Automation 360 integration with Citrix enables you to create боты that run tasks on remote Citrix Virtual
Apps servers.
Задачи, связанные с данной
Using the Recorder on Citrix Virtual Apps servers
The Record: Capture cloning action requires specific configurations to capture objects from applications
available through the Citrix StoreFront on a remote Citrix Virtual Apps server. Ensure the required
components are installed on the local machine and the remote Citrix Virtual Apps server.
Installing the Citrix required components on local machines
Install the Automation Anywhere components to enable you to use боты on Citrix Virtual Apps servers.
Two components are installed: Bot Agent and Automation Anywhere plug-in for Citrix.
Ссылки, связанные с данной
Components for Control Room and бот actions
Control Room and боты have additional requirements depending upon the Automation 360 deployment
model you choose. Some third party applications are installed with Automation 360.

Install Automation Anywhere remote agent for Citrix 2.0: Средство записи пакет version 2.8.6
Install the Automation Anywhere remote agent for Citrix 2.0 available with Build v 2.0.0.7 on the Citrix
Virtual Apps server where the virtual applications are installed.
Keep the following considerations in mind when automating a task in the Citrix environment using the new
Automation Anywhere remote agent for Citrix 2.0:
• If you are using Google Chrome for automation, ensure that the Automation Anywhere extension

(version 3.0.0.0 or later) for Automation 360 remote agent is installed and enabled.
Google Chrome extension for Automation 360

• Both Automation Anywhere remote agent for Citrix 1.0 and 2.0 can run on Citrix environment at the
same time.

• When you use the 2.8.6-20220823-160834 or later version of the Средство записи пакет in your боты,
we strongly recommend that you use the Automation Anywhere remote agent for Citrix 2.0. If you
have not installed the Automation Anywhere remote agent for Citrix 2.0, then we have support for an
automatic fallback where the existing Automation Anywhere remote agent for Citrix 1.0 will be used.
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Прим.:  During fallback, the Automation Anywhere remote agent for Citrix 1.0 will work only with
technologies and browsers that it supports.

• For Citrix automation, боты created using the 2.8.6-20220823-160834 or later version of the Средство
записи пакет will not work with the Automation Anywhere remote agent for Citrix 2.0 if you downgrade
the package to version 2.7.3-20220527-004608 of the Средство записи.

• We strongly recommend that you avoid using both the new Automation Anywhere remote agent for
Citrix 2.0 and the Bot Agent installed over same Citrix environment because doing so can cause issues
with browser automation with either of the approaches.

• If you have боты that use 2.7.3-20220527-004608 or earlier version of the Средство записи пакет,
then the боты will use the existing Automation Anywhere remote agent for Citrix 1.0.

• Automation 360 remote agent will not work if Citrix XenDesktop is also connected.
• Technology selection drop-down option for Средство записи is not supported.
• Microsoft UI automation (COM) is not supported.
• SAP automation is not supported.

The following technologies and browsers are supported with Automation 360 remote agent for Citrix:
• Google Chrome
• Internet Explorer
• Microsoft Edge
• Microsoft Edge в режиме IE
• Mozilla Firefox
• Java
• Electron apps
• Microsoft Active Accessibility (MSAA)
• Microsoft UI automation

1. Log in to the Citrix Virtual Apps server.
2. Download the latest version of the Automation Anywhere remote agent for Citrix 2.0 installer file to

the Citrix Virtual Apps server. The Automation 360 remote agent running on the Citrix server interprets
data received from Automation 360 and responds appropriately.
a. Go to A-People Downloads page (Login required).
b. Select and download the Automation Anywhere remote agent for Citrix 2.0.

3. Run the Automation Anywhere remote agent for Citrix 2.0 installer.
a. Extract the AARemoteAgent_2.0.zip file and double-click the A360RemoteAgent.exe file.
b. On the Automation 360 Remote agent Setup screen, click Next.
c. On the Select Destination Folder screen, click Browse to specify a non-default location for

installing the remote agent. Щелкните Вперед.
The default location for installation is set to C:\Program Files (x86)\Automation
 Anywhere\A360 Remote Agent.

d. On the Setup Status screen, track the status of the installation process.
e. On the Setup Wizard Complete screen, click Finish to complete the setup.

4. From the Citrix interface, add the Automation Anywhere remote agent for Citrix 2.0 application to the
Citrix Delivery Controller.
This registers the Automation Anywhere remote agent for Citrix 2.0 as a Virtual App in the Citrix
StoreFront.
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5. Verify that the Automation Anywhere remote agent for Citrix 2.0 is available from the Citrix StoreFront.
The Citrix StoreFront name for the Automation Anywhere remote agent for Citrix 2.0 remote agent is
A360 Remote agent.

Install Automation Anywhere remote agent for Citrix 1.0: Средство записи пакет version 2.7.3 and earlier
Install the Automation Anywhere remote agent for Citrix 1.0 available with Build v 1.0.0.0 on the Citrix
Virtual Apps server where the virtualized applications are installed.
Keep the following considerations in mind when automating a task in the Citrix environment using the
Automation Anywhere remote agent for Citrix:
• If an application hosted on the Citrix environment runs in elevated mode, the Automation Anywhere

remote agent for Citrix must also run in elevated mode.
• If some applications hosted on the Citrix environment run in elevated mode and some on non-elevated

mode, you can install two instances of the Automation Anywhere remote agent for Citrix: One instance
of the agent will run in elevated mode and the other instance in non-elevated mode.

• If you are using Google Chrome for automation, ensure the Automation Anywhere extension (version
11.2.0.0) for Automation Anywhere remote agent for Citrix is installed and enabled.
Chrome web store

1. Log in to the Citrix Virtual Apps server.
2. Download the latest version of the Automation Anywhere remote agent for Citrix installer file to the

Citrix Virtual Apps server. The Automation Anywhere remote agent for Citrix running on the Citrix
server interprets data received from Automation 360 and responds appropriately.
a. Go to A-People Downloads page (Login required).
b. Select and download the Automation Anywhere remote agent for Citrix.

3. Запустите установщик Automation Anywhere remote agent for Citrix.
a. Extract the AARemoteAgent_1.0.zip file and double-click the

AAE_Remote_Agent_1.0.0.exe file.
b. On the Automation Anywhere Remote Agent Setup screen, click Next.
c. On the License Agreement screen, accept the license agreement, and click Next.
d. On the Select Destination Folder screen, click Browse to specify a non-default location for

installing the remote agent. Щелкните Вперед.
The default location for installation is set to: C:\Program Files (X86)\Automation
 Anywhere\AARemoteAgent

e. On the Setup Status screen, track the status of the installation process.
f. On the Setup Wizard Complete screen, click Finish to complete the setup.

4. From the Citrix interface, add the Automation Anywhere remote agent for Citrix application to the
Citrix Delivery Controller.
This registers the Automation Anywhere remote agent for Citrix as a Virtual App in the Citrix
StoreFront.

5. Verify that the Automation Anywhere remote agent for Citrix is available from the Citrix StoreFront.
The Citrix StoreFront name for the Automation Anywhere remote agent for Citrix is AARemoteAgent.
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HA and DR deployment models
Automation 360 provides several deployment options to meet various levels of enterprise cost/price
performance and resiliency requirements. The options include installation on single nodes and on multiple
nodes. Multi-node deployments can be configured for highly available (HA) clusters and disaster recovery
(DR) sites.
The deployment services are set up using the Automation 360 installer. A typical Automation 360 server
node runs the following services:
• Automation Anywhere Automation Services
• Automation Anywhere Messaging Services
• Automation Anywhere Caching Services
• Automation Anywhere Search Services
• Repository storage
• (Optional) IQ Bot VM

The Automation 360 installer also supports the multi-node deployment configuration.

Planning

Identify your requirements before selecting a deployment model. For best results, deploy the same
operating systems across the Рабочая область RPA development, testing, and production environments.
At minimum, have the same OS on both test and production environments.

Модели развертывания

At a high level, there are two ways to deploy or install Automation 360 - single-node and multi-node.
Choose the option that meets your business continuity requirements.

Single-node deployment

As the name suggests, there is a single physical server node, on which all the services related to
Automation 360 are run. By design, this configuration does not provide any redundancy and hence the
availability depends on the services on this single node.

База данных In single-node deployment, the database can be
anywhere if the Control Room server is able to
connect to the database server. This can involve
network configurations.

Прим.:  You cannot host the database server on
the same server as the Control Room server as it
requires higher processing/memory configuration on
the server.

Characteristics • No disaster recovery (single point of failure):
If the single node fails, RPA operation will be
adversely affected.

• No high availability: If the server is taken offline
for upgrade or maintenance, RPA operations will
be affected.
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• No RPA up-scaling: When RPA deployments
scale up and users increase, the single node will
have to manage the increased load. This might
adversely affect the RPA performance.

Usage Recommendations Single-node deployments are typically
recommended for small-scale usage in proof of
concepts, demos, testing, and trials, to name a few.
Single-node deployments are NOT RECOMMEDED
for production usage because any downtime will
impair RPA operation and business continuity.

Advantages • Quick and easy installation and setup
• Additional servers not required
• Load balancers and clustering configuration not

required

The following image shows the Automation Anywhere and data center components for a single node. The
Automation Anywhere components are shown in orange and components provided by your organization
are shown in blue. Components that are centrally hosted on cloud and managed by Automation Anywhere
such as license server are shown in light orange.
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Multi-node deployment

To achieve higher processing scale, higher availability in production setups, Automation 360 services are
deployed across multiple server nodes. Installer enables you to setup multi-mode configuration. This
involves additional configuration steps such as linking services to same database and so on.

Distributed approach The Control Room provides the flexibility to process
large number of requests in given time window.
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Deploy multiple instances of Control Room on
multiple physical or virtual servers as required. This
also means configuring the cluster setup for the
caching, search, and messaging services.

Балансировщик нагрузки Performed by a load balancer, this is the process
of distributing application or network traffic across
multiple servers to protect service activities,
allowing workloads to be distributed among
multiple servers. This ensures automation activity is
continued on clustered servers.
Load balancer requirements

Databases In multi-node deployments, databases use their
own built-in failover to protect the data. This
ensures database data recovery.
If you use cloud-based database services likes
of AWS-RDS, the High Availability and Disaster
Recovery as part of their service offerings, in
which case no further database configurations are
necessary.
For pure on-premises database scenarios, configure
synchronous replication between the primary
(active) and secondary (passive) clustered Microsoft
SQL Server in the data center. This ensures
consistency in the event of a database node failure.
For synchronous replication, configure the database
using publisher and subscriber model in Microsoft
SQL Server from the primary disaster recovery site
to the secondary disaster recovery site that is at a
geographically separated location from the primary
site.
Replicate data between primary and secondary sites

The following image shows the Automation Anywhere and data center components for three nodes in a
data center cluster. The Automation Anywhere components are shown in orange and components provided
by your organization are shown in blue. Components that are centrally hosted on cloud and managed by
Automation Anywhere such as license server are shown in light orange.
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Важное замечание:  Stretch clusters are not supported.
• Ensure that all the HA cluster nodes are configured in the same location. Do not configure the nodes in

a single HA cluster that is located across various sites. Ensure that you configure one HA cluster at the
primary site and the other HA cluster at the secondary site.
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• The Control Room and IQ Bot must be configured in the same data center to ensure communication
between both the applications.

Понятия, связанные с данным
High availability deployment
To support Automation 360 in your data center, configure an high availability (HA) cluster. Follow your
company methods and procedures for implementing your data center cluster.

Convert single-node deployment to multi-node deployment
You can convert your single-node deployment into a multi-node deployment by editing the configuration
files and restoring the data in the repository for the single-node setup.
The single-node deployment can run on one of several infrastructures, local machines, private data
centers, and cloud providers.
To convert a single-node deployment running on AWS or other supported environment into a multi node-
deployment, perform the following steps.
1. In the Task Manager, stop all Automation Anywhere services.
2. Stop the Control Room instance.
3. Create an Amazon Machine Images (AMI) instance using the Control Room instance.

For information about how to create AMI in AWS, see Create an AMI from an Amazon EC2 Instance.
4. Create a new instance using the AMI created in the previous step.
5. Edit the configuration files related to the database server, Ignite cluster, and Elasticsearch to form the

clusters in the configuration directory on a standard installation.
The files are located in C:\Program Files\Automation Anywhere\Enterprise\config
a) Edit the database server URL to point to the intended database server in

boot.db.properties.
Do not change the URL if the original server already refers to a non-localhost address.

b) Edit the following property in the cluster.properties file:
Append the list with a new server IP in ignite.discovery.static.ips=<existing list
 of ips>, <current server ip>

c) Edit the following properties in the elasticsearch.yaml file:
• Add the current server address in node.name: "<local-ip>"
• Add the current server address in network.host: "local-ip"
• Leave the existing values intact and append the IP of the current server in

discovery.zen.ping.unicast.hosts: ["ip1","<local-ip>"]
• Leave the existing values intact in cluster.initial_master_nodes: ["<master-

ip>"]

6. Restore and mount the repository to the respective path from the same timed snapshot as the
selected Control Room snapshot.

7. Update the configuration tables to ensure TCP visibility between the nodes.
8. Start the services on the replicated node and wait for a couple of minutes for the clustering to

establish.
9. Log in to the Control Room to verify whether the боты are available and the repository structure is

intact.
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10. Check Git integration for standard installations.
If the installation has external Git configured, check the validity by exercising test check-in and
confirm audit logs.

High availability deployment
To support Automation 360 in your data center, configure an high availability (HA) cluster. Follow your
company methods and procedures for implementing your data center cluster.

Why only odd number of nodes are supported A cluster comprising even number of nodes can
merge inconsistencies but can result in a split-brain
condition where the cluster has no majority and
cannot resolve transactions, which might result
in data inconsistencies. Split-brain condition is a
known limitation of clustering systems that can be
caused by network issues including latency.
Deployment configurations with odd numbered
nodes can help avoid split-brain issues and are
recommended for Automation 360 deployments.

Quorum The nodes determine which transaction can be
processed through voting on each transaction.
The number of votes constituting a majority of the
nodes in the cluster is referred to as a quorum and
determines how many nodes have to vote for or
confirm a transaction before it can be processed.

Fault Tolerance Fault tolerance in terms of node failure is
determined by how many nodes can fail before
a quorum or majority of nodes is not available
to vote on the validity of any transaction. Fault
tolerance is optimized with an odd number of nodes
in the cluster because a majority in odd-numbered
clusters is a lower number than in even-numbered
clusters

Supported Configurations A cluster with three or higher odd number of nodes
prevents the split-brain condition or inconsistencies
due to network issues, while giving the higher scale
and availability.

Number of
nodes in
cluster

Majority
(quorum)

Fault
tolerance
(node
failures)

Поддержка

3 2 1 Certified

5 3 2 Contact
Automation
Anywhere
support

7 and so
on

4 and so
on

3 and so
on

Contact
Automation
Anywhere
support
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Multi-availability Zone/Multi-datacenter
Configurations

When going for a multi-zone deployment in
further enhance the availability, say with 3 nodes
deployment, we recommend that you have each
Control Room in separate availability zones.
Deployments with more than 3 nodes, spread these
deployments across at least 3 availability zones.
One thing we need to be concerned about in these
setups is the latency between the zones/providers.
The nodes in a high availability cluster must be
deployed in the same region.
In terms of the cloud providers, we currently
support 3 major cloud providers - Amazon Web
Services, Google Cloud Platform, and Microsoft
Azure.

Прим.:  In a multi-node environment, if a node goes down, operations such as бот deployments and
schedules, triggers, and work items in queues on that node will be adversely affected.

Совет:  For information on how to backup and restore files to recover a Control Room High Availability
cluster in case of failure, see Backing up and restoring a Control Room High Availability Cluster (A-People login
required).

Понятия, связанные с данным
Disaster recovery deployment
The disaster recovery (DR) deployment model uses high availability (HA) clusters distributed across
separate geographic areas.
Задачи, связанные с данной
Настроить IP-кластер
Use the Cluster Configuration wizard page under Custom installation type in Control Room installer
to configure resiliency requirements. Select the Enable Cluster setup option and for high availability
cluster, provide multiple (three or more) IP addresses from your cluster setup.
Configure disaster recovery site for Elasticsearch IP addresses
If you have configured the Control Room for high availability (HA) and disaster recovery (DR) and installed
the Control Room on both the primary and secondary sites, configure Elasticsearch IP addresses for the
secondary site.
Информация, связанная с данной
Cluster coordination in ElasticSearch

Disaster recovery deployment
The disaster recovery (DR) deployment model uses high availability (HA) clusters distributed across
separate geographic areas.
Disaster recovery (DR) is a method where the two high availability (HA) data center configurations are
separated geographically. In the event of a localized disaster at the primary site, the physically removed
data center on the secondary site can resume functions with minimum downtime.
If there were external systems used in the setup, it is essential to restore the network level connectivity.
Some examples for these external systems include any external key vaults, Git, and so on. All the firewall
rules, IP white-listings, host-names referred in configurations are still intact and available to the restored
services.

Прим.:  The Control Room clusters in the primary and secondary disaster recovery sites are recommended
to use a minimum of three nodes each because a three-node configuration can help avoid split-brain issues
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with two-node clusters and increase security by using node authentication and transport layer security
(TLS) features.

The following image shows the Automation Anywhere and data center cluster components for three nodes
in primary and secondary sites configured for disaster recovery. The Automation Anywhere components
are shown in orange and components provided by your organization are shown in blue. Components that
are centrally hosted on cloud and managed by Automation Anywhere such as license server are shown in
white.
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Disaster recovery methods

There are two ways to perform disaster recovery - Image based replication and Warm standby. Choose the
option that meets your business continuity requirements.
Задачи, связанные с данной
Image based replication
The replication process is similar across environments and cloud providers. A scheduled way is used for
creating and storing the snapshots. The snapshot interval is based on the tolerance of the customer for
potential data loss.
Replicate data between primary and secondary sites
The process of replicating the data between the primary and the secondary site involves database
replication using publisher and subscriber models in Microsoft SQL Server Management Studio, server
repository replication using Windows Distributed File System (DFS), and backing up Elasticsearch (audit
log) data.
Информация, связанная с данной
Cluster coordination in ElasticSearch

Image based replication
The replication process is similar across environments and cloud providers. A scheduled way is used for
creating and storing the snapshots. The snapshot interval is based on the tolerance of the customer for
potential data loss.
We recommend that the replication schedule should be at least 1 day (one snapshot daily).
The following describes the procedure for AWS as an example cloud provider.

As a first step in any image-based DR setup, create snapshots at fixed intervals. In case of the disaster, the
setup would revert to the latest good image/snapshot and system would be back, up and fully functional in
a short time, however with a data loss and short down time.
1. Decide on the snapshot interval based on potential data loss.
2. Stop the Automation Anywhere services on the server being imaged.
3. If on AWS, create AMI using standard image creation steps.

Create an AMI from an Amazon EC2 Instance

4. After the image is created, start the Automation Anywhere services.
5. Run the repository backup mechanism on the same schedule.
The subsequent steps describe restoring data from an image.
6. Spin a new instance using the previously created AMI.

Depending on the original setup, if the setup is spread across availability zones, you must do the same
in all relevant availability zones.

The following steps are applicable to each instance being recovered.
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7. Edit the configuration files related to the database server, Ignite cluster, and Elasticsearch to form the
clusters in the configuration directory.
On a standard installation, the files are located in: C:\Program Files\Automation Anywhere
\Enterprise\config

a) Edit the database server URL to point to the intended database server in:
boot.db.properties.
Do not change the URL if the original server already refers to a non-localhost address.

b) Edit the following property in the cluster.properties file:
Append the list with a new server IP in: ignite.discovery.static.ips=<existing list
 of ips>, <current server ip>

c) Edit the following properties in the elasticsearch.yaml file:
• Add the current server address in: node.name: "<local-ip>"
• Add the current server address in: network.host: "local-ip"
• Leave the existing values intact and append the IP of the current server in:

discovery.zen.ping.unicast.hosts: ["ip1","<local-ip>"]
• Leave the existing values intact in: cluster.initial_master_nodes: ["<master-

ip>"]

8. Необязательно: If mounted, restore the repository from the same timed snapshot as the selected
Control Room snapshot and mount to the respective path.

9. Update configuration tables.
10. Ensure Transmission Control Protocol (TCP) visibility between the nodes.
11. Start the services on the replicated node and wait for couple of minutes the clustering to establish.
12. Verify the following:

• Login and check the боты are listed and visible.
• If the installation has external Git configured, check the validity using functions such as check-in.
• Verify the audit logs.

13. Update the load balancer tier or DNS as needed if any host names/IPs change with corresponding
current values.

Задачи, связанные с данной
Replicate data between primary and secondary sites
The process of replicating the data between the primary and the secondary site involves database
replication using publisher and subscriber models in Microsoft SQL Server Management Studio, server
repository replication using Windows Distributed File System (DFS), and backing up Elasticsearch (audit
log) data.
Warm stand-by
Host two setups or sites - primary and backup for the warm stand-by DR procedure.

Warm stand-by
Host two setups or sites - primary and backup for the warm stand-by DR procedure.
Each setup would have following recommended configurations:
1. Automation 360 hosted in clustered mode (three nodes)
2. SQL instance
3. Repository storage (shared network drive)
4. Git repository
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Synchronous replication of the data onto the backup node should be configured. The backup node should
have the exact same configuration as Primary node; except for Control Room.
• To sync Git repository, back up Git repository path from primary to backup path.
• To sync SQL database, setup replication from primary to backup database.

Replicate data between primary and secondary sites

Once configured the setup scheme would look like this:
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Complete the disaster recovery deployment on the two geographically separated sites, where one site is
the primary (active) site and the other is the secondary (passive) site used for backup. If the primary site
cluster fails, perform recovery on the secondary site.

Прим.:  The secondary site should be set up as a passive configuration so that the failover procedure can
be performed without delay.

The procedure is identical regardless of whether you are switching over from primary to secondary, or
from the secondary to primary sites. Connect the Control Room to the replicated database and shared the
repository on the secondary site.
These steps apply to all the servers in the Automation 360 cluster, including the Control Room servers, SQL
server, and Elasticsearch server.
1. Install Automation 360 on the secondary site.

Follow the steps for installation up to the database configuration.
Installing Control Room using Custom mode

2. In the Database Configuration window, add database details for the secondary site such as the
database server IP address and default port number.
Configure Microsoft database type and server

3. Verify the Elasticsearch details in the Provide Elasticsearch Credentials window.
Because the Elasticsearch data is already replicated from the primary database, you do not have to
provide the Elasticsearch password.

4. After the installation is complete, verify that the Control Room URL and repository path is available in
the Control Room Welcome page.
You can change the Control Room URL and repository path after you log in to the Control Room as the
next step.

5. Log in to the Control Room using your administrator credentials to change the Configuration
Settings in Administration > Settings:
a) To allow users to access the Control Room using a public IP address, change the Control Room

Access URL settings to point to the secondary site access URL in General Settings > General.
b) Change the Repository path to the secondary site repository path in Control Room database

and software > Control Room repository.

6. Verify the data for the following:
• Users, roles, schedule, triggers, credential information, and workload settings
• Elasticsearch certificate and connectivity
• Automation Anywhere Robotic Interface, Bot Insight, Discovery Bot, and IQ Bot

Прим.:  Perform a byte-by-byte measurement of the recovered data and compare the primary and
secondary site data. If you see any difference, verify the subscriber logs for any intermittent failure
due to any network issue.

After the recovery site is operating as the primary site, configure a replacement secondary site. Using the
database tools, set up replication from the recovery primary site to the replacement secondary site.

Replicate data between primary and secondary sites
The process of replicating the data between the primary and the secondary site involves database
replication using publisher and subscriber models in Microsoft SQL Server Management Studio, server
repository replication using Windows Distributed File System (DFS), and backing up Elasticsearch (audit
log) data.
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Before installing Automation 360, ensure that you have set up your secondary site.
Configure the database and shared repository in the secondary site that is used for disaster recovery. Back
up your Elasticsearch data by setting up the backup cluster.
1. Replicate the database from the primary site to the secondary site using the publisher and

subscriber models in Microsoft SQL Server Management Studio.

Recommendations:
• Use the Microsoft SQL Server Developer or Enterprise edition for database replication.

The publisher and subscriber versions must be the same, or the gap between the two versions
must not be more than two releases. For example, do not use Microsoft SQL Server 2012 publisher
with Microsoft SQL Server 2019 subscriber.

• Configure the publisher and distributor on the same system to avoid latency in data sharing.
Use different systems only for load distribution, for example, for data larger than 200 GB.

a) Connect to the primary database to create a snapshot publication for your local publications.
b) Add the tables and views as articles.
c) Use the snapshot agent option to create a snapshot and keep the snapshot available to initialize

subscriptions.
d) Schedule the snapshot agent to back up the data at regular intervals (for example, every 10

seconds from 12 AM to 11:59:59 PM).
e) To select the account to run the snapshot agent, configure the security and agent settings.
f) Add a publication option.
g) Run all agent and distributors after ensuring that the publisher and database names are correct.
h) To add subscribers to the local subscriptions, connect to the database server and provide

connection details for the database at the secondary site.

For detailed steps, see Database Mirroring and Replication (SQL Server).
2. Replicate the repository (боты and data files) using the Windows DFS from the primary site to the

secondary site.
a) Open the DFS on the machine where the shared repository is saved.
b) Create a new multipurpose replication group to add replication group members.

The group members include the source machine in the primary site and the destination machine
in the secondary site to store the shared repository.

c) Use the full mesh option for DFS replication groups composed of less than 10 servers.
d) Use the full bandwidth option to replicate the data continuously.
e) Add the machine where you are configuring the repository as a primary member.
f) Add a backup folder for the shared repository from the destination machine.
g) Verify that the data is replicated in the backup folder on the destination machine.

For detailed steps, see Distributed File System Replication.
3. Back up the Elasticsearch (audit log) data by adding the secondary site cluster IP address in the

Control Room on the primary site.
For detailed steps, see Configure disaster recovery site for Elasticsearch IP addresses.
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Задачи, связанные с данной
Warm stand-by
Host two setups or sites - primary and backup for the warm stand-by DR procedure.

Installing Control Room using custom mode for Oracle installation
Install the Automation Anywhere Control Room using Oracle Database for On-Premises and complete the
installation in the Control Room.
Ensure the following:
• Oracle Database is preconfigured in your environment before you complete the Control Room

installation.
• Oracle 19c On-Premises or over AWS RDS Oracle is supported. Ensure that the following settings are

enabled with version 19c:
• The value of the Oracle instance max_string_size parameter is set to EXTENDED.
• If you want to use the SSL/TLS connection for the database, it is required that you configure TLS on

the Oracle Server.
• Oracle credentials are created. Database credentials must be created and the following grants must

be provided: CONNECT, RESOURCE, CREATE TABLE, CREATE VIEW.

Прим.:  The QUOTA on tablespace USERS is UNLIMITED.

Прим.:  External vault integration is not supported on Oracle-based Windows Control Room
installation.

Procedure

1. Prepare for installation
• Verify Automation 360 On-Premises prerequisites.
• Убедитесь в том, что у вас есть следующее.

• Automation Anywhere Control Room installation file
• TLS certificate
• License file

2. Run Control Room installer.
Run the installer to verify the operating system and hardware requirements, select the deployment
option, accept the licensing agreement, and select the installation file path.

Прим.:  Ensure that you select Oracle for Database type.

3. Configure application Transport Layer Security.
Use the Transport Layer Security (TLS) configuration page to generate a self-signed certificate
or import a security certificate to set up a highly secure Control Room instance.

4. Настроить учетные данные службы.
Use the Service Credentials page to specify the account that will be used to run all Windows
services that are created by the installer.
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5. Configure Oracle database type and server

Use the Database type page to configure the Oracle Database for use with the Control Room.
6. Add Elasticsearch credentials.

Add Elasticsearch credentials for enhanced monitoring and alerting in the Control Room.
7. Настроить IP-кластер.

Use the Cluster Configuration page to configure resiliency requirements. Provide only one IP
address to configure the Control Room on a single node. Provide multiple (three or more) IP addresses
to configure the Control Room for high availability cluster.

8. Review the installation summary.
Use the Ready to Install the Program page to complete the installation wizard and monitor the
installation progress.

9. Complete Control Room configuration and validation.

Complete Control Room post-installation
configuration

After installing the Control Room, complete
the configuration settings to ensure that timely
Automation Anywhere communications are
specified and confirm that Automation Anywhere
services are running.

Post-installation user management After completing the post-installation tasks,
validate the setup by logging in to the Control
Room and installing a license. First-time access
to the Control Room walks you through the
configuration for your authentication method.

10. Prepare for users.
As an administrator, you can create, view, edit, delete, and enable or disable a user. The steps for
creating users can vary depending on whether the user is a non-Active Directory, Active Directory, or
single sign-on (SSO) user from an IdP server.

Installing Control Room using Custom mode
Log in to the server as an administrator and install Automation Anywhere Control Room in Custom mode to
select installation and configuration options, including installing non-default requirements. Select this mode
for a data center deployment.

Linux users:  См. раздел Installing Control Room on Linux.

Procedure

1. Prepare for installation
• Verify Automation 360 On-Premises prerequisites.
• Убедитесь в том, что у вас есть следующее.

• Automation Anywhere Control Room installation file
• TLS certificate
• License file
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2. Run Control Room installer

Run the installer to verify the operating system and hardware requirements, select the deployment
option, accept the licensing agreement, and select the installation file path.

3. Select the database type that you want to use
• Microsoft SQL Server
• Oracle

4. Use the External key vault integration page to configure a connection to an external key vault
such as CyberArk or AWS Secrets Manager, that is optionally used for retrieving credentials for either
installation or runtime purposes. Configuring the key vault connection enables retrieval options for
credentials during installation. Ensure that you have the follow information:
• All necessary database and user credentials.
• Any necessary credential requirements for the external key vault such as secret keys, application

IDs. See the specific requirements for your external key vault on the External Key Vault integration
configure page.

5. Configure application Transport Layer Security

Use the Transport Layer Security (TLS) configuration page to generate a self-signed certificate
or import a security certificate to set up a highly secure Control Room instance.

6. Настроить учетные данные службы
Use the Service Credentials page to specify the account that will be used to run all Windows
services that are created by the installer.

7. Настройка типа и сервера базы данных
Use the Database type page to configure the Microsoft SQL Server database, or Oracle Database for
use with the Control Room.
• Configure Microsoft database type and server
• Configure Oracle database type and server

8. Add Elasticsearch credentials

Add Elasticsearch credentials for enhanced monitoring and alerting in the Control Room.
9. Настроить IP-кластер

Use the Cluster Configuration page to configure resiliency requirements. Provide only one IP
address to configure the Control Room on a single node. Provide multiple (three or more) IP addresses
to configure the Control Room for high availability cluster.

10. Review the installation summary

Use the Ready to Install the Program page to complete the installation wizard and monitor the
installation progress.

11. Complete Control Room configuration and validation

Complete Control Room post-installation
configuration

After installing the Control Room, complete
the configuration settings to ensure timely
Automation Anywhere communications are
specified and confirm Automation Anywhere
services are running.

Post-installation user management After completing the post-installation tasks,
validate the setup by logging in to the Control
Room and installing a license. First-time access
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to the Control Room walks you through the
configuration for your authentication method.

12. Prepare for users

As an administrator, you can create, view, edit, delete, and enable or disable a user. Creating users
steps vary depending on whether the user is a non-Active Directory, Active Directory, or single sign-on
(SSO) user from an IdP server.

Понятия, связанные с данным
Миграция в Automation 360

Run Control Room installer
Run the installer to verify the operating system and hardware requirements, select the deployment option,
accept the licensing agreement, and select the installation file path.
To install Automation Anywhere Control Room in Custom Mode, follow these steps:
1. Start the installer wizard.

a) Extract all files from the Automation360_Build_<build-number>.zip file.
b) Right-click the Automation360.exe file and select Run as administrator.

The installation process will create a Control Room database with the name Automation360-Database
on your SQL database server instance.
However, if you are migrating from Enterprise 11 to Automation 360, the restored Enterprise 11
database will be used instead of the Automation 360 database.

Прим.:  Ensure the SQL database server is installed on a different server than that of the Control
Room.

The installation process checks for supported operating system and recommended hardware
requirements. The following message appears if the requirements are not met:
This system does not meet all the installation prerequisites for Automation
 Anywhere Enterprise. 
Some features might not work as expected after installation. For details,
 verify the Control Room Installation Prerequisite. 

Подробнее см. в разделе Automation 360 On-Premises prerequisites.
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2. Select the On-Premises deployment type and click Next.

In On-Premises deployment type, the Control Room, Боты and files are installed on your servers.
In Cloud-enabled deployment type, all data such as боты and files are installed on your servers. The
management functions of the Control Room are delivered through Cloud.

3. Accept the licensing agreement and click Next.
4. Выберите вариант Пользовательский и щелкните кнопку Далее.

The Destination Folder page appears. By default, the destination folder is C:\Program Files

\Automation Anywhere\. 
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5. If you are upgrading from one Automation 360 version to another, confirm the upgrade and choose
whether to use the existing installation parameters.
Existing installation parameters include, for example: the installation path, HTTPS ports, database
names, IP addresses, and TLS configuration. The username and password have to be manually
entered.
• Yes—all the installation parameters are pre-filled and disabled. You cannot change pre-filled fields.
• No—enter the same or different installation parameters through the installation prompts.

Прим.:  Choose No if the previous installation did not use the default installation path C:
\Program Files.

6. To make changes to the destination folder, click Change, enter a new destination folder name, and
click OK.

Прим.:  Do not install the application directly in the root directory (C:\). You should create a folder,
for example, C:\Program Files\Automation Anywhere\Automation360\.

7. Click Next.

Integrate external key vaults
You can integrate external key vaults to the Automation 360 On-Premises Control Room.
As part of your external key vault integration planning strategy, if you determined that you are using an
Automation 360 On-Premises Control Room deployment (where the Control Room and external key vault
are hosted at the customer's site and environment), then select from the following list of external key
vaults to configure:
• CyberArk Password Vault – Customer On-Premises environment

On-Premises integration using CyberArk Password Vault
• Azure Key Vault – Customer Azure environment

On-Premises integration using Azure Key Vault
• AWS Secrets Manager – Customer AWS environment

On-Premises integration using AWS Secrets Manager

Configure application Transport Layer Security
Use the Transport Layer Security (TLS) configuration wizard page from the Automation 360 installer
to generate a self-signed certificate or import a security certificate to set up a highly secure Control Room
instance.

Automation Anywhere leverages TLS 1.2 and TLS 1.3 encryptions for HTTPS and TCP communications
between our components. The TLS certificates are installed on the Automation Anywhere Control Room
and IQ Bot servers. The certificates are installed in .PFX format and leveraged for communications.
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Прим.:  If your load balancer uses HTTP to forward traffic to the Control Room, do not use the Enable
Force HTTP traffic to HTTPS option. We recommend that you use HTTPS to forward the load balancer
traffic for enhanced security instead.

1. In the TLS Configuration page, configure the following:
• Generate a Self-Signed Certificate

Enabling the Self-Signed Certificate option allows the installer to generate a unique private key
and a self-signed certificate for the Control Room.

• Import a Certificate
To import a custom certificate, clear the Self Signed Certificate check box. This setting allows
you to import a certificate using the Certificate Path field.

Прим.:  The certificate file must be a PKCS12 format.

Provide the following information:
• Certificate Path: Click Browse to import the certificate.
• Private Key Password: Enter the password for the private key.

Password limitation:  Do not use the at sign (@) in passwords. Using the special character @
in the password causes the certificate file import to fail.

• Webserver Port: Enter the web server port – either HTTP or HTTPS. If the port is already
assigned, an error message is displayed.

Важное замечание:  The port validation message is also displayed when you add 8080
for the web server and if that port is already in use for a Control Room license service. Use a
different unassigned port in these cases.

• Enable Force HTTP traffic to HTTPS: This option redirects all HTTP port requests to HTTPS.
To access to the Control Room through HTTPS using the generated self-signed certificate,
ensure the port numbers are different for HTTP and HTTPS.
To generate a custom certificate for HTTPS, ensure your custom certificate meets the following:
• Create a .pfx certificate with a pass code from a CA trusted authority.
• Combine Root, Intermediate, and Machine level certificates into a single certificate.
• Use the format [WS Machine Host Name].[DomainName].com for the private key.
• Include the host name as a fully qualified domain name (FQDN) in the certificate.

You provide the host name during Control Room installation.
• In multi-node HA clusters, issue certificates to the load balancer DNS name.
• Add individual URLs, which require access to all nodes, to the Subject Alternative

Name field in the certificate.

For more information, see Automation Anywhere support site: Automation 360 On-Premises
prerequisites (A-People login required).
The following sample illustration shows options for importing a custom certificate:
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2. Click Next to configure service credentials.
Настроить учетные данные службы

Задачи, связанные с данной
Configure Control Room for HTTPS certificate
Configure Control Room for HTTPS mode using a self-signed or CA certificate either before or after
performing a custom Control Room configuration.
Import HTTPS,and CA certificates
After you install the Control Room for an On-Premises deployments, you can use the Windows or Linux
command prompt to import all or some of these certificate:
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Настроить учетные данные службы
Continue from the Control Room installer to the Service Credentials wizard page. Use this page to
specify the account that will be used to run all Windows services that are created by the Automation
Anywhere installer.
1. In the Service Credentials screen, choose from the listed options.

The Windows Service credentials include a user name and password. The user specified must meet
these requirements:
• Have permission to manage services, including Automation Anywhere services.
• If you use Windows authentication to connect to the SQL database, ensure you grant the

db_owner permission to the service credential user.

These service credentials allow the Control Room processes to run the required services.
• Local System Account—(default) The logged-on user performing the installation.

• Use a Group Managed Service Account—Specify to manage Automation 360 services.
a. Clear the Local System Account check box.
b. Select the Use a Group Managed Service Account option.
c. Enter the user name only. No password is required to use this option.

Group Managed Service Accounts Overview
• Domain Account—Specify a user that is not the local system account user

a. Clear the Local System Account check box.
b. Enter the user name and password for the domain account.

Для имени пользователя и пароля используйте только поддерживаемые символы. См.
раздел Supported special characters.

• • Do not use the Windows domain credentials
Enter credentials valid for running Automation Anywhere services. Without the valid
credentials, the Control Room will fail to launch.

• PowerShell script restrictions
Specify a user with permissions to launch PowerShell scripts who is not a Windows domain
user. Without the relevant permissions, database table creation can fail.

• Service Account (manually enter credential)
a. Введите имя пользователя.
b. Введите пароль.

• Service Account (optionally retrieve service account credential from the previously
configured external key vault )
a. If using CyberArk, enter the safe name and object name for the credential.
b. Если используется AWS Secrets Manager, введите имя секрета.
c. If using Azure, enter the vault URL.

The following example shows selection of a domain account:
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2. Щелкните Вперед.

Configure Microsoft database type and server
Перейдите из установщика Control Room на страницу мастера Тип базы данных. Use this page to
configure the Microsoft SQL Server database for use with the Control Room.
Эта процедура применима только к установкам на базе Microsoft Windows Server.

Linux users:  См. раздел Установка Enterprise Control Room на Linux — конфигурация базы данных.

Если вы устанавливаете Automation 360 как часть миграции, эта задача включает шаг выбора
(клонированной) базы данных Enterprise 11.
1. Выберите базу данных Microsoft SQL Server.

Экземпляр Сервер SQL должен быть уже настроен.
2. Щелкните Вперед.

Отобразится страница Сервер базы данных (если для настройки базы данных вы выбрали
SQL Server).
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3. Установите подключение и аутентификацию для сервера базы данных.
To configure the Database Server for the Control Room instance, use the default Database Server
port 1433. If multiple instances are running on the same database host on different ports, you can use
the corresponding custom port for that instance (for example, 1435 or 1437).

Прим.:  The instance name is not supported in the Database Server field.

Прим.:
• По возможности не устанавливайте для параметра Сервер базы данных значение

localhost. Если необходимо использовать localhost, обратите внимание на то, что
Безопасное подключение к базе данных не будет работать.

•
• Щелкните Обзор, чтобы выбрать экземпляр Сервер SQL, в котором будет создана база

данных Control Room. Либо же введите имя сервера базы данных или выберите его из
списка.

Задача миграции. Если вы выполняете миграцию с Enterprise 11 на Automation 360, перейдите
к восстановленной базе данных Enterprise 11.
Укажите следующие сведения:
a) Порт базы данных: Используйте порт по умолчанию (1433) или укажите

пользовательское значение.
Configure default database port

b) Использовать безопасное подключение. Выберите этот вариант, чтобы использовать
сертификат ЦС, как указано.

Прим.:  Используйте одно и то же имя хоста для подключений сертификата и базы данных.

c) Сертификат: Этот параметр включается, когда вы выбираете Использовать безопасное
подключение. Выполните обзор для выбора сертификата ЦС.
Import HTTPS,and CA certificates

d) Выберите один из указанных ниже вариантов аутентификации базы данных.
• Аутентификация Windows. Этот параметр выбран по умолчанию и позволяет

подключаться к Сервер SQL с использованием аутентификации Windows.

Прим.:  Если вы выбрали аутентификацию Windows, то пользователь, запускающий
установщик, будет проверять существование базы данных, создавать ее при
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необходимости и предоставлять db_owner пользователю учетной записи службы (NT
Authority/System).

• Аутентификация SQL Server: (ввод учетных данных вручную). Выберите этот
параметр, чтобы для подключения к базе данных использовать аутентификацию Сервер
SQL. Укажите правильное имя пользователя и пароль для аутентификации SQL.
1. Введите имя пользователя.
2. Введите пароль.

• Аутентификация SQL Server: (получение учетных данных из внешнего хранилища
ключей). Выберите этот параметр, чтобы для подключения к базе данных использовать
аутентификацию SQL Server.

Прим.:  Аутентификация SQL Server требуется, если вы будете получать учетные данные
для базы данных из внешнего хранилища ключей.

1. Если используется CyberArk, введите безопасное имя и имя объекта.
2. Если используется AWS Secrets Manager, введите имя секрета.

• Аутентификация AD Azure. Выберите этот параметр, чтобы использовать учетные
данные Active Directory Microsoft Azure для подключения к базе данных при установке
Control Room на Microsoft Azure.

Для имени пользователя и пароля используйте только поддерживаемые символы. См.
раздел Supported special characters. Не используйте в пароле базы данных точку с запятой
( ; ).

e) Имя базы данных Control Room: Введите имя базы данных Control Room.
Задача миграции. Если вы выполняете миграцию с Enterprise 11 на Automation 360,
введите имя восстановленной базы данных в поле базы данных, как показано на
приведенном ниже изображении.
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The following sample illustration shows Сервер SQL authentication for database

connection:
4. Щелкните Вперед, чтобы указать учетные данные Elasticsearch.

Add Elasticsearch credentials

Configure default database port
Configure and enable the TCP/IP in the SQL database server to use the default port 1433 when you install
the Control Room.
Enable TCP/IP from the Microsoft SQL Server Configuration Manager.
1. Ensure the SQL Server Browser service is running in the Task Manager.
2. To set the default port for the SQL database server, launch the Microsoft SQL Server Configuration

Manager.
3. Select SQL Server Network Configuration > Protocols for <SQL server instance>.
4. Right-click Protocols for <SQL server instance> and select Open to show the available protocols.
5. Ensure TCP/IP is enabled.
6. Right-click TCP/IP and select Properties.

You can configure the default port for the SQL database from the TCP/IP Properties window that is
displayed.

7. Select the IP Addresses tab to update the default TCP Port to 1433 in the IPAll node.
If provided, clear the value shown in the TCP Dynamic Ports field.

8. Click OK to confirm and exit the window.
9. Select the SQL Server Services option to Restart the SQL Server <instance name>.

The SQL database server is now configured and enabled to use the default port in the Control Room.

Configure Oracle database type and server
Configure the Oracle Database Server for use with the Control Room by using the База данных type
wizard page.
This procedure applies only to installations based on Microsoft Windows Server.
Oracle must be installed on a machine that is accessible from the Automation 360 Control Room.
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Create users for Automation Anywhere to access the База данных.
This is supported only on non-container База данных. Oracle installation is supported only for first-time
setup of Automation Anywhere. Oracle installation does not support updates.

Прим.:  Oracle database for Control Room installation is supported only in Custom mode and not in
Express mode.

1. Select Oracle database.
An instance of the Oracle Server must be configured already. Подробнее см. в разделе Installing
Control Room using custom mode for Oracle installation.

2. Щелкните Вперед.
The Oracle Database server page is displayed (if you selected Oracle for configuring your database).
The following sample illustration shows Oracle Database Server authentication for database
connection:

3. Установите подключение и аутентификацию для сервера базы данных. Укажите следующие
сведения:
a) Database Server: Enter the server name or IP address of the Oracle Database server.

The localhost IP address can be used.
b) Порт базы данных: Enter your database server port number. The default port is 1521.
c) For the connection, select one of the following options and enter the name of your Oracle

instance in the text field:

Вариант Action in text field (example)

SID ORCL
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Вариант Action in text field (example)

Имя службы ORCLPDB

Прим.:  The SID and service name entered in the text field provided is unique to your Oracle
database. The Oracle instance name entered in the text field is not case-sensitive.

4. In the Username field, enter your Oracle database user or schema name.
5. In the Password field, enter the password for the user or schema name.
6. Использовать безопасное подключение. Выберите этот вариант, чтобы использовать

сертификат ЦС, как указано.

Прим.:  Используйте одно и то же имя хоста для подключений сертификата и базы данных.

7. Сертификат: This option is enabled when you select Use Secure Connection. Browse to select a
CA certificate.
Import HTTPS,and CA certificates

8. Щелкните Вперед.
The database connection begins validating for the database server and the elastic search.

9. Enter the Elasticsearch credentials in the fields provided.
Add Elasticsearch credentials

Add Elasticsearch credentials
When installing Automation 360, add Elasticsearch credentials for enhanced security.
Based on whether you are performing a new installation, running the setup for the first time to upgrade to
a later version, or a subsequent re-installation, the options to add the Elasticsearch credentials or select a
backup Elasticsearch server are enabled.
1. In the Provide Elasticsearch Credentials window, enter the credentials for Elasticsearch in the

Elasticsearch password field.

Важное замечание:  Ensure the following for your Elasticsearch authentication password:
• The password cannot include a space, semicolon (;), percent (%), or backslash (\).
• The first character cannot be a minus sign (-) or forward slash (\).
• Include at least one alphabetical character.

This option is enabled only for the primary node of the cluster when you run the setup for the
first time for an upgrade or a new installation of the Control Room. When you enter the password,
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self-signed certificates are generated for encrypting the data traffic for inter-node and client
communication.
The option is disabled for subsequent installations because the password and certificates are retrieved
and reused from the second node onwards.

2. Repeat the credentials in the Confirm Elasticsearch password field.
3. Select the Check only if installing on the first node of the backup Elasticsearch cluster check

box when you want to install the Control Room on the primary node that will be used as a backup for
the Elasticsearch cluster.
This option is available only if you have provided the Elasticsearch credentials for the primary node
during a previous installation. The option enables you to use the database backup that is created from
the Elasticsearch settings table after the primary node of the cluster is installed.
The option is disabled for subsequent installations.

4. Click Next to configure the IP cluster.

If you encounter errors when performing this task, see these resources:
• Error on storing Elasticsearch certificate to database, see Installation error storing Elasticsearch certificate

to database (A-People login required).
• Error restarting the Automation Anywhere Elastic Search Service, see Automation 360 v.16 upgrade error:

Elasticsearch Service fail to start during certificate retrieval process (A-People login required).

Настроить IP-кластер.

Настроить IP-кластер
Use the Cluster Configuration wizard page under Custom installation type in Control Room installer
to configure resiliency requirements. Select the Enable Cluster setup option and for high availability
cluster, provide multiple (three or more) IP addresses from your cluster setup.
Before you install Control Room in cluster mode:
• Ensure that the default/custom and configurable firewall, port, and protocol requirements for

Automation 360 deployment are configured. Подробнее см. в разделе Требования к портам,
протоколам и брандмауэру.
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• Ensure that the network location (UNC) path is configured to access the repository files from all Control
Room nodes in the cluster.
Ensure that the Network Attached Storage (NAS) file sharing can be configured using Server Message
Block (SMB) protocol.

• Ensure that all nodes that will be configured for the IP cluster are available for configuration before
the installation. Also, while installing on each of the node, ensure that the list of IP addresses of all
nodes are provided in the same order when configuring the Cluster IP addresses field in Cluster
Configuration wizard page.

• Ensure to sign all the PowerShell files if the machine on which you are installing Automation 360 has
MachinePolicy as AllSigned or UnRestricted. For example on how signing in a Windows PowerShell
script, see Signing in Windows PowerShell scripts.

To view the MachinePolicy on your machine, run the following command in PowerShell:

Get-ExecutionPolicy -List

You can find the following PowerShell files in the temp folder:
• servicecredsvalidate
• getsysip
• getfileprodversion
• ecertprocess
• createstoragetables
• createpddtables
• createiqbottables
• createcrdbtables
• createaaridbtables

Example of a temp folder path: C:\Users\ADMINI~1.FD\AppData\Local\Temp\<GUID>.

Прим.:  GUID is generated dynamically for each installer session.

A sample URL for reviewing the health of the cluster is:

https://<cr ip>:47599/_cat/health?pretty

You are prompted to enter the following credentials:
• Username: es_client (default)
• Пароль. <your set_ elastic_search_password>

A green or yellow color icon is displayed for a healthy cluster.

1. Select the Enable Cluster Setup check box.
2. If the nodes in your network use IPv6 address, select the IPv6 check box.
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3. Enter the IP addresses of the nodes in the cluster.
Use a comma (,) to specify more than one IP address. For example, to specify three IP addresses in
the cluster, enter: 192.0.2.1,192.0.2.2,192.0.2.3

Прим.:  The first IP address in the list is used as the initial master node. Ensure that you enter the IP
addresses in the same order on all node configurations in subsequent installations.

You can install multiple nodes at the same time after the master node is installed. After installation,
you can add a new IP address to the cluster at the end of the list. However, you cannot change the IP
address version (such as IPv4 to IPv6).

4. Select an IP address from the Local IP Address drop-down list.
If multiple local IP addresses are configured on the machine, ensure that you select
an IP address (private IP address recommended) on which the Control Room is
installed, as it will be used by other nodes internally to communicate with each other.

5. Click Next to complete the Control Room installation process.
6. Необязательно: To review or monitor the installation progress, see Setup installation summary.

Понятия, связанные с данным
High availability deployment
To support Automation 360 in your data center, configure an high availability (HA) cluster. Follow your
company methods and procedures for implementing your data center cluster.
Задачи, связанные с данной
Configure application Transport Layer Security
Use the Transport Layer Security (TLS) configuration wizard page from the Automation 360 installer
to generate a self-signed certificate or import a security certificate to set up a highly secure Control Room
instance.
Ссылки, связанные с данной
Control Room repository requirements
The repository location is configured in the Control Room after installation. All your automations are stored
in this repository.
Требования к портам, протоколам и брандмауэру
Просмотрите требования по умолчанию и настраиваемые требования к брандмауэру, портам и
протоколам для развертывания Automation Anywhere. View the default ports and protocols that are

© 2023 Automation Anywhere. All rights reserved.     924



    Automation Anywhere - Install and update Automation 360

required to be allowed on customer's firewall for Automation Anywhere deployment. The default ports that
are used for HTTP/HTTPS are configurable.

Add nodes to a cluster setup
As an RPA platform administrator, you can add nodes to a cluster for better performance and better load
distribution.
Ensure the following:
• Verify whether the prerequisites for on-premises installation are met.

Automation 360 On-Premises prerequisites
• Verify that all the primary nodes and databases have backups.
• You must have the IP addresses of all the cluster members for the Control Room server network

interfaces used for Elasticsearch communications.

Прим.:  The Control Room servers can have multiple network interfaces. The server IP addresses must
be statically assigned and cannot use the Dynamic Host Configuration Protocol (DHCP).

• If any external load balancers are used in the environment, update them with IP addresses from the
new server nodes.

• Ensure that you have administrator or root privileges on the Control Room servers. You must be familiar
with installing Control Room in custom mode and also with the related configuration settings.

Adding nodes to a cluster helps you to upgrade the configuration of the nodes in a cluster. You can add
nodes to a Control Room cluster setup, change the IP addresses of nodes in the cluster, and monitor the
health of the underlying cluster services.

Прим.:  The minimal number of nodes supported within a Control Room cluster is three. The nodes in a
cluster synchronize with each other over a local network. All the nodes in a cluster connect to the same
database.

Perform the following steps to add three nodes (N4, N5, and N6) to a cluster that has three nodes (N1, N2,
and N3).
1. On node N4, log in to the operating system as an administrator and run the Control Room installer.
2. Proceed through the installer to the cluster configuration.

a) Select Enable Cluster Setup.
b) In the Cluster IP addresses box, enter the IP addresses of all the nodes that you need to

configure in the cluster.
172.31.30.120, 172.31.21.216, 172.31.17.110, 172.31.20.242,
 172.31.17.149, 172.31.18.37

c) Select or add your Local IP address.

Прим.:  The IP addresses must be entered in the same sequence on every node.

3. Restart the nodes, one at a time.
After you restart the nodes, each node will have six IP addresses.

4. Complete the remaining steps to install Control Room.
Installing Control Room On-Premises

5. Repeat the steps 1 through 4 for nodes N5 and N6.
6. Ensure that all the Control Room services have started for all the nodes.
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7. To verify the health of the cluster, use the Elasticsearch API through a browser or API tool.
a) From a browser, navigate to the IP address of any node in the cluster by using the Elasticsearch

port 47599 and use the _cat/nodes API.
https://172.31.30.120:47599/_cat/nodes

The master node is indicated by an asterisk character (*).
b) Verify that the IP address of the master node is the same as the one mentioned in the

elasticsearch.yml file for all the nodes.
c) From a browser, navigate to the IP address of any node in the cluster by using the Elasticsearch

port 47599 and use the _cat/health?pretty API.
https://172.31.30.120:47599/_cat/health?pretty

You must wait until the replication status turns green. The replication time varies depending on the
data load in the clusters. The replication status turns green when the cluster is fully synchronized.

Remove nodes from a cluster setup
As an RPA platform administrator, you can remove nodes from a Control Room cluster setup to replace
them or upgrade them for enhanced performance.
Ensure the following:
• Verify that all the primary nodes and databases have backups.
• Ensure that you have administrator or root privileges on the Control Room servers.

Perform the following steps to remove three nodes (N1, N2, and N3) from a cluster that has six nodes (N1,
N2, N3, N4, N5, and N6).
1. Verify the master node. Use the following Elasticsearch API through a browser or API tool to identify

the master node:
https://172.31.18.37/_cat/nodes

2. Log in to the server as an administrator and stop all the Control Room services by running the
following command:
services.msc

Log in to any of the original nodes N2 or N3 and not the master node N1.
3. Similarly, stop all the Control Room services for the master node N1.
4. Before removing the nodes, verify the health of the cluster by using the following Elasticsearch API

through a browser or API tool:
From a browser, navigate to the IP address of any node in the cluster by using the Elasticsearch port
47599 and use the _cat/nodes API.
https://172.31.18.37/_cat/nodes

Прим.:  The master node is indicated by an asterisk character (*).

5. Edit the cluster.properties file located at C:\Program Files\Automation Anywhere
\Automation 360\config.

6. Remove the IP addresses for the original three nodes from the cluster.properties attribute.

Прим.:  Perform this action for all the nodes in the cluster. When you remove the IP addresses of the
original three nodes, do not change their sequence.

7. Edit the elasticsearch.yml file at C:\Program Files\Automation Anywhere\Automation
 360\elasticsearch\config.
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8. Remove the IP addresses for the original three nodes from the discovery.zen.ping.unicast.hosts
attribute.

Прим.:  The discovery.zen.ping.unicast.hosts attribute must contain the IP addresses only for the new
nodes and in the same sequence within the file on each node.

9. To verify the new master node, use the following Elasticsearch API through a browser or API tool:
https://172.31.18.37/_cat/nodes

10. Update the IP address of the new master node in the cluster.initial_master_nodes attribute.
11. Run the following command to start the services on each node:

services.msc

You must start the services on the master node at the end.
12. To verify the health of the cluster, use the Elasticsearch API through a browser or API tool.

a) From a browser, navigate to the IP address of any node in the cluster by using the Elasticsearch
port 47599 and use the _cat/nodes API.
https://172.31.30.120:47599/_cat/nodes

Прим.:  The master node is indicated by the asterisk character (*).

b) From a browser, navigate to the IP address of any node in the cluster by using the Elasticsearch
port 47599 and use the _cat/health?pretty API.
https://172.31.30.120:47599/_cat/health?pretty

You must wait until the replication status turns green. The replication time varies depending on
the amount of data in the clusters. The replication status turns green when the cluster is fully
synchronized.

Setup installation summary
Continue from the Control Room installer to the Ready to Install the Program wizard page. From this
stage of the installation wizard, you finish the installation wizard and monitor the installation progress.
1. Щелкните Вперед.

The Ready to Install the Program screen appears.
2. Click Install and allow the installation process to complete.

The InstallShield Wizard Completed screen appears.
3. Click Finish.

Launch Automation Anywhere is enabled by default.
Enable Show installer settings to open the aae-installsummary.html file. By default, this is
located at C:\Program Files\Automation Anywhere\Enterprise\. Use this file to view a
summary of the installation.

Complete the Control Room configuration and validation.
• Complete Control Room post-installation configuration

After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.

• Post-installation user management

After completing the post-installation tasks, validate the setup by logging in to the Control Room and
installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.
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• Пользователи
As a Cloud user with administrator permissions, you can create, view, edit, delete, and enable or disable
a user. Creating users steps vary depending on whether the user is a non-Active Directory, Active
Directory, or single sign-on (SSO) user from an IdP server.

Задачи, связанные с данной
Installing Control Room using Express mode

Installing Control Room using Express mode
Log in to the servers as an Administrator and install Automation Anywhere Control Room in Express Mode
using the default settings.

Прим.:  Linux users, see Installing Control Room on Linux.

• Verify Automation 360 On-Premises prerequisites.
• Убедитесь в том, что у вас есть следующее.

• Automation Anywhere Control Room installation file
• TLS certificate
• License file

Важное замечание:  This installation mode is ideal for demo and training purposes. This installation
mode is not recommended for the production environment.

The Express Mode installation quickly sets up the Control Room with default parameters for the various
components.
Default parameters
Microsoft SQL Server is the default database for Control Room.
The following parameters are installed by default:

Параметр Значение по умолчанию

SQL database instance SQLEXPRESS

Тип проверки подлинности Аутентификация Windows

База данных Control Room Automation360-Database

Порт 1433

To install Automation Anywhere Control Room in Express Mode, follow these steps:
1. Log in to the installation server.
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2. Start the installer wizard.
a) Extract all files from the Automation360_Build_<build-number>.zip file.
b) Right-click the Automation360.exe file and select Run as administrator.

The installation process creates the Control Room database with the name Automation360-Database
on your SQL database server instance.

Прим.:  Ensure the SQL database server is installed on a different server than that of the Control
Room.

The installation process checks for supported operating system and recommended hardware
requirements. The following message appears if the requirements are not met:
This system does not meet all the installation prerequisites for Automation
 Anywhere Enterprise. 
Some features might not work as expected after installation. For details,
 verify the Control Room Installation Prerequisite. 

Подробнее см. в разделе Automation 360 On-Premises prerequisites.
3. Click Next on the Welcome to the Setup Wizard page.
4. Select one of the following deployment types and click Next:

Тип развертывания Описание

On-Premises The Control Room, Боты and files are installed on
your servers.

С поддержкой облака All data such as боты and files are installed on
your servers. The management functions of the
Control Room are delivered through Cloud.

5. Accept the licensing agreement and click Next.
6. On the Installation Type page, select the Express option and click Next.

The Database Server configuration page appears.
a) Enter the port you want to use to connect to the database server in the Port field.

The default port is 1433. The installer uses the first available port and checks the availability of
each consecutive port.

b) Select any one of the following options to connect to the database server.

Вариант Действие

Use Windows Authentication The system uses your Windows
credentials. The Login ID and
Password fields are disabled in the
installer.

Sql Server authentication Enter the Login ID and Password
used for connecting to the database
server.
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Вариант Действие

AD Azure authentication Enter the Login ID and Password
used for connecting to the database
server.
Select this option to use Microsoft Azure
Active Directory credentials to connect
to the database when you install the
Control Room on Microsoft Azure.

Прим.:  The user who connects to the database server must have database creator privileges.

c) Enter the name of the database that you want to use for Control Room in the Name of Control
Room database field.

7. Click Next on Provide Elasticsearch credentials page to configure Elasticsearch for enhanced
monitoring and alerting in the Control Room.

Важное замечание:  Ensure the following for your Elasticsearch authentication password:
• The password cannot include a space, semicolon (;), percent (%), or backslash (\).
• The first character cannot be a minus sign (-) or forward slash (\).
• Include at least one alphabetical character.

This option is enabled only for the primary node of the cluster when you run the setup for the
first time for a new installation or an upgrade of the Control Room. When you enter the password,
self-signed certificates are generated for encrypting the data traffic for inter-node and client
communication.
The option is disabled for subsequent installations because the password and certificates are retrieved
and reused from the second node onwards.

8. Необязательно: When you want to install the Control Room on the primary node that will be used as
a backup for the Elasticsearch cluster, select the Check only if installing on the first node of the
backup Elasticsearch cluster check box.
This option is available only if you have provided the Elasticsearch credentials for the primary node
during a previous installation. The option enables you to use the database backup that is created from
the Elasticsearch settings table after the primary node of the cluster is installed.
The option is disabled for subsequent installations.

9. Щелкните Вперед.
10. On the Ready to Install the Program, click Install and allow the installation process to complete.

During this process, the Automation 360 services are started automatically.
11. On the InstallShield Wizard Completed page, click Finish.

Launch Automation 360 is enabled by default.
Enable Show installer settings to open the aae-installsummary.html file. By default, this is
located at C:\Program Files\Automation Anywhere. Use this file to view a summary of the
installation.

The Control Room launches in your default browser with the Configure Control Room settings page
displayed. Proceed to Complete Control Room post-installation configuration.
Понятия, связанные с данным
Installing Control Room using Custom mode
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Log in to the server as an administrator and install Automation Anywhere Control Room in Custom mode to
select installation and configuration options, including installing non-default requirements. Select this mode
for a data center deployment.

Installing Control Room on Amazon Web Services
Log in to an Amazon Web Services (AWS) server instance as Administrator. Then, download and start the
Control Room installer and select Custom mode.

Прим.:
• Many possible system configurations and requirements exist. These installation steps do not account for

all those possibilities, so your specific setup and installation steps will vary, and Automation Anywhere
does not make any warranties that these steps conform to your specific configurations.

• For Automation 360 to work properly on Amazon Workspace, update the registry on all Workspace
machines. For details, see Совместимость устройств.

Шаг 1. Prepare for installation • Verify Automation 360 On-Premises prerequisites.
• Убедитесь в том, что у вас есть следующее.

• Automation Anywhere Control Room
installation file

• TLS certificate
• License file

Шаг 2. Prepare for installation on Amazon Web
Services

Use these steps to prepare the Amazon Web
Services (AWS) instances for the Control Room
installation.

Шаг 3. Customize Control Room installation on
Amazon Web Services

Install and apply the customized configuration
required for the Control Room cluster on Amazon
Web Services (AWS) after completing initial
preparations.

Шаг 4. Complete Control Room configuration
and validation. Complete Control

Room post-installation
configuration

After installing the
Control Room, complete
the configuration
settings to ensure timely
Automation Anywhere
communications are
specified and confirm
Automation Anywhere
services are running.

Post-installation user
management

After completing the
post-installation tasks,
validate the setup by
logging in to the Control
Room and installing a
license. First time access
to the Control Room
walks you through the
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configuration for your
authentication method.

Шаг 5. Prepare for users. Пользователи As a Cloud user
with administrator
permissions, you can
create, view, edit,
delete, and enable
or disable a user.
Creating users steps
vary depending on
whether the user is a
non-Active Directory,
Active Directory, or
single sign-on (SSO)
user from an IdP server.

Prepare for installation on Amazon Web Services
Use these steps to prepare the Amazon Web Services (AWS) instances for the Control Room installation.
If you have not done so already, prepare your AWS Identity and Access Management (IAM) user account
to login to the AWS Console.
Do the following:
1. Create AWS Elastic Compute Cloud (EC2) Instances for the Control Room Servers.
2. If you use RDS, create Relational Database Service (RDS) Instances for the SQL Server Enterprise

2014 Database server.
3. Configure the AWS Load Balancer.

Прим.:  There are many possible system configurations and requirements. These installation steps do
not account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.

To prepare AWS instances, do the following:
1. Set up the Microsoft SQL Server on Amazon Web Services Elastic Compute Cloud (AWS EC2) or

Relational Database Service (RDS).
AAE supports both. For a comparison of the two, see Microsoft SQL Server on AWS.

2. Test the database connection with the Microsoft SQL Server.
a) Install Microsoft SQL Management Studio on one of the AWS EC2 instances inside the Virtual

Private Cloud (VPC).
For more information, see Download SQL Server Management Studio.

b) Connect to the Microsoft SQL Server.
For configuration information, see Working with SQL Servers.

c) (Skip this step if the master database user installs the Control Room). Create the following empty
database and assign db_owner privileges to the master database user for the Automation360-
Database.
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3. Set up the shared repository.
a) Create an AWS EC2 instance as a Windows File Server with an additional volume of 100 GB.
b) Join the Active Directory domain.
c) Create a folder and set up the permissions for the repository.

Assign the Control Room admin full access to this folder.

Важное замечание:  Only the Control Room admin is to have full access to this folder because
this is the account from which all Control Room services run.

4. Launch three AWS instances, one for each Control Room server.
a) Establish three AWS instances, each with the following configuration:

• Type: c5.2xlarge or similar instance type (8 CPU, 16 GB RAM)
• Storage: Root Device: 100 GB
• Storage: Additional Device: D:\ 200 GB (For Automation Anywhere Install files)
• Accidental Deletion Prevention: Включено

b) Access the three instances through Remote Desktop Protocol.
c) Add the instances to the Active Directory domain.
d) For each instance, add the Control Room system admin as a local administrator on the computer

and reboot the system.

5. Configure the firewall and port.
См. раздел Требования к портам, протоколам и брандмауэру.

6. Set up the AWS Application Load Balancer.
See Details for Elastic Load Balancing Products.
• Disable the stickiness attribute.
• Set the idle time-out to 120 seconds.

7. Upload the SSL certificate to the Load Balancer.

Continue with Customize Control Room installation on Amazon Web Services.

Customize Control Room installation on Amazon Web Services
Install and apply the customized configuration required for the Control Room cluster on Amazon Web
Services (AWS) after completing initial preparations.
If you have not done so already, complete the initial installation steps in Prepare for installation on Amazon
Web Services.

Прим.:  There are many possible system configurations and requirements. These installation steps do
not account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.

To install the Control Room in a cluster setup, do the following steps:
1. Login to the first AWS instance as an Administrator.
2. Download Automation Anywhere_<version>.exe.
3. Click Next on the Welcome to the Setup Wizard page.
4. Accept the licensing agreement and click Next.
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5. Выберите вариант Пользовательский и щелкните кнопку Далее.
The Destination Folder page appears. By default, the destination folder is C:\Program Files
\Automation Anywhere\Enterprise\.

6. To make changes to the destination folder, click Change, enter a new destination folder name, and
click OK.

Прим.:  Do not install the application directly in the root directory (C:\). You should create a folder,
for example, C:\Program Files\Automation Anywhere\Enterprise\.

7. Click Next to configure the IP cluster.
8. Select the Enable Cluster Setup check box.

The check box is enabled by default if the machine on which the setup is being run has local IP
addresses configured.
To install the Control Room on a single node and not a cluster, clear the Enable Cluster Setup check
box.

9. Enter the IP addresses of the nodes in the cluster.
• Enter IPv6 addresses if all the nodes in the network are using IPv6.
• Enter IPv4 addresses if some nodes in the network are using a combination of IPv4 and IPv6

addresses.

a) Use a comma (,) to specify more than one IP address.
For example, to specify three IP addresses in the cluster, enter:
192.0.2.1,192.0.2.2,192.0.2.3

Важное замечание:  The first IP address in the list is used as the master node. Ensure
that you enter the IP addresses in the same order on all node configurations in subsequent
installations. An incorrect order causes the application to configure the IP addresses as separate
clusters, which will result in data loss when the issue is fixed after installation.

You can install multiple nodes at the same time after the master node is initially installed.
After installation, you can add a new IP address to the cluster at the end of the list.

b) After you enter the cluster IP addresses correctly, select a valid address IP at the message prompt
to provide network access to the machine.

10. Click Next to configure the application Transport Layer Security (TLS).
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11. In the TLS Configuration page, configure the following:
• Generate a Self-Signed Certificate

Enabling the Self-Signed Certificate option allows the installer to generate a unique private key
and a self-signed certificate for the Control Room.

• Import a Certificate
To import a custom certificate, clear the Self Signed Certificate check box. This setting allows
you to import a certificate using the Certificate Path field.

Прим.:  The certificate file must be a PKCS12 format.

Provide the following information:
• Certificate Path: Click Browse to import the certificate.
• Private Key Password: Enter the password for the private key.

Password limitation:  Do not use the at sign (@) in passwords. Using the special character @
in the password causes the certificate file import to fail.

• Webserver Port: Enter the web server port – either HTTP or HTTPS. If the port is already
assigned, an error message is displayed.

Важное замечание:  The port validation message is also displayed when you add 8080
for the web server and if that port is already in use for a Control Room license service. Use a
different unassigned port in these cases.

• Enable Force HTTP traffic to HTTPS: This option redirects all HTTP port requests to HTTPS.
To access to the Control Room through HTTPS using the generated self-signed certificate,
ensure the port numbers are different for HTTP and HTTPS.
To generate a custom certificate for HTTPS, ensure your custom certificate meets the following:
• Create a .pfx certificate with a pass code from a CA trusted authority.
• Combine Root, Intermediate, and Machine level certificates into a single certificate.
• Use the format [WS Machine Host Name].[DomainName].com for the private key.
• Include the host name as a fully qualified domain name (FQDN) in the certificate.

You provide the host name during Control Room installation.
• In multi-node HA clusters, issue certificates to the load balancer DNS name.
• Add individual URLs, which require access to all nodes, to the Subject Alternative

Name field in the certificate.

For more information, see Automation Anywhere support site: Automation 360 On-Premises
prerequisites (A-People login required).

12. Click Next to configure the service credentials.
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13. In the Service Credentials screen, choose from the listed options.
The Windows Service credentials include a user name and password. The user specified must meet
these requirements:
• A member of the local system administrator group.
• Have permission to manage services, including Automation Anywhere services.
• If you use Windows authentication to connect to the SQL database, ensure you grant the

db_owner permission to the service credential user.

These service credentials allow the Control Room processes to run the required services.
• Local System Account—(default) The logged-on user performing the installation
• Domain Account—Specify a user that is not the local system account user

a. Clear the Local System Account check box.
b. Enter the user name and password for the domain account.

Для имени пользователя и пароля используйте только поддерживаемые символы. См.
раздел Supported special characters.

• Do not use the Windows domain credentials
Enter credentials valid for running Automation Anywhere services. Without the valid credentials,
the Control Room will fail to launch.

• PowerShell script restrictions
Specify a user with permissions to launch PowerShell scripts who is not a Windows domain user.
Without the relevant permissions, database table creation can fail.

14. Add the SQL Server and click Next.
Select Microsoft SQL Server, type the Name, and click Next.

15. On the InstallShield Wizard Completed page, click Finish.
Launch Automation Anywhere is enabled by default.
Enable Show installer settings to open the aae-installsummary.html file. By default, this is
located at C:\Program Files\Automation Anywhere\Enterprise\. Use this file to view a
summary of the installation.

The Control Room launches in your default browser with the Configure Control Room settings page shown.
Continue with Configure settings post-installation on Amazon Web Services.

Configure settings post-installation on Amazon Web Services
After installation is complete, configure Control Room settings on Amazon Web Services.
If you have not done so already, complete the installation steps in Customize Control Room installation on
Amazon Web Services.

Прим.:  There are many possible system configurations and requirements. These installation steps do
not account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.
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To install Automation Anywhere on Amazon Web Services (AWS), do the following steps:
1. Configure the following Control Room settings:

a) Specify the host name URL by providing the AWS Load Balancer URL.
This is the URL that users use to access your installation of Control Room.

b) Select the Active Directory authentication type. Подробнее см. в разделе Configure Control Room
for Active Directory: manual mode.

2. After you configure the Control Room, install product licenses.
3. Test Control Room access using the AWS Load Balancer URL.

This completes the Control Room installation on AWS.

Complete the Control Room configuration and validation.
• Complete Control Room post-installation configuration

After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.

• Post-installation user management

After completing the post-installation tasks, validate the setup by logging in to the Control Room and
installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.

• Пользователи
As a Cloud user with administrator permissions, you can create, view, edit, delete, and enable or disable
a user. Creating users steps vary depending on whether the user is a non-Active Directory, Active
Directory, or single sign-on (SSO) user from an IdP server.

Installing Control Room on Microsoft Azure
Installing Control Room on Microsoft Azure begins in the Azure environment and ends with configurations
in the Control Room.

Прим.:  There are many possible system configurations and requirements. These installation steps do
not account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.

Шаг 1. Prepare for installation. • Verify Automation 360 On-Premises prerequisites.
• Убедитесь в том, что у вас есть следующее.

• Automation Anywhere Control Room
installation file

• TLS certificate
• License file

Шаг 2. Verify readiness for installation on Microsoft
Azure

Use these steps to configure third-party products
for the Control Room installation.

Шаг 3. Begin Control Room installation on Microsoft
Azure

Initial steps for Control Room installation on
Microsoft Azure.
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Шаг 4. Customize Control Room installation on
Microsoft Azure

Install and apply the customized configuration
required for the Control Room cluster on Microsoft
Azure.

Шаг 5. Complete Control Room configuration
and validation. Complete Control

Room post-installation
configuration

After installing the
Control Room, complete
the configuration
settings to ensure timely
Automation Anywhere
communications are
specified and confirm
Automation Anywhere
services are running.

Post-installation user
management

After completing the
post-installation tasks,
validate the setup by
logging in to the Control
Room and installing a
license. First time access
to the Control Room
walks you through the
configuration for your
authentication method.

Шаг 6. Prepare for users. Пользователи As a Cloud user
with administrator
permissions, you can
create, view, edit,
delete, and enable
or disable a user.
Creating users steps
vary depending on
whether the user is a
non-Active Directory,
Active Directory, or
single sign-on (SSO)
user from an IdP server.

Verify readiness for installation on Microsoft Azure
Use these steps to configure third-party products for the Control Room installation.

Прим.:  There are many possible system configurations and requirements. These installation steps do
not account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.
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To configure third-party products prior to installation, do the following steps:
1. Ensure the installation environment meets the data center requirements and collect the necessary

information about the following components:
• Load balancer - IP address
• Microsoft SQL Server - port credentials
• Azure SMB file share - address credentials
• Enterprise identity management system (optional)

If you have Active Directory (AD) - AD server domain credentials
• SMTP - host port HTTP/S ports for TLS (optional)
• Control Room servers - Have Windows credential manager installed

Refer to Поддерживаемые версии компонентов центров обработки данных в Microsoft Azure for
configuration and version information.

2. Configure the Network Security Group as per the recommended security policies for Inbound Port
rules:

Объект центра обработки
данных

Порт Протокол

Control Room • 80
• 443

Любое

LDAP • 3268
• 3269

Любое

эл. почта SMTP 587 Любое

SSH 22 Любое

RDP 3389 TCP

3. Configure the AD server.
Ensure all users are part of the AD domain and the AD server is setup in IaaS mode for Azure cluster
environment installations. To add user, navigate to Active Directory Users and Computers >
<domain> > Users and add the necessary user.
To configure the AD server on Azure with IDaaS, refer to the Microsoft Azure documentation.
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4. Ensure the Control Room servers in the cluster can ping each other.
If the ping is not successful:
a) In Windows Defender Firewall with Advanced Security>Inbound rules, set the following

values for the file and printer sharing firewall rule:
• Имя. File and Printer Sharing (Echo Request - ICMPv4-In)
• Group: File and Printer Sharing
• Profile:All
• Enabled: Да
• Action: Разрешить
• Override: Нет
• Program: Любое
• Local address: Любое
• Remote address: Любое
• Protocol: ICMPv4

b) Ping the Control Room after enabling the firewall rule change.

When you have completed the pre-installation configurations, Begin Control Room installation on Microsoft
Azure.

Поддерживаемые версии компонентов центров обработки данных в Microsoft
Azure
For installing Automation Anywhere on the Microsoft Azure cluster environment, the versions of data center
components that are supported are identified for each component.

Объект центра обработки
данных

Поддерживаемая версия Конфигурация

Операционная система Control
Room

• Microsoft Windows
Server 2012 и 2012 R2
Datacenter

• Microsoft Windows
Server 2016 Standard и
Datacenter

• Microsoft Windows
Server 2019 Standard и
Datacenter

IaaS

Управление удостоверениями:
Azure Active Directory

Azure Active Directory • IDaaS
• Windows 2016 для IaaS

SMB File Share Azure File Share с протоколом
Server Message Block 2.0 и 3.0
(SMB)

PaaS

Load Balancer Балансировщик нагрузки
Azure

PaaS

Azure Application Gateway
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Объект центра обработки
данных

Поддерживаемая версия Конфигурация

Microsoft SQL Server База данных Azure SQL с
отдельной базой данных
(Microsoft SQL Azure (RTM) —
12.0.2000.8)

PaaS

Begin Control Room installation on Microsoft Azure
Initial steps for Control Room installation on Microsoft Azure.
If you have not done so already, complete the pre-installation configuration in Verify readiness for
installation on Microsoft Azure.

Прим.:  There are many possible system configurations and requirements. These installation steps do
not account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.

To begin the installation:
1. Use Remote Desktop Connection (RDC) to connect to the Control Room server, as an Administrator,

and run the Control Room installer.
2. Click Yes to start the installer.
3. Click Next on the Welcome to the Setup Wizard page.
4. Accept the licensing agreement and click Next.
5. Выберите вариант Пользовательский и щелкните кнопку Далее.
6. Click Next to setup the system IPs.

The Cluster Configuration window displays.

Continue with Customize Control Room installation on Microsoft Azure.

Customize Control Room installation on Microsoft Azure
Install and apply the customized configuration required for the Control Room cluster on Microsoft Azure.
If you have not done so already, complete the initial installation steps in Begin Control Room installation on
Microsoft Azure. This task requires the configuration information you gathered in the prerequisites stage.
This includes IP addresses, certificates, and credentials for the the Control Room servers, datacenter
servers, and databases.

Прим.:  There are many possible system configurations and requirements. These installation steps do
not account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.

Важное замечание:  Automation 360 software components are not compatible with Distributed
Resource Scheduling (DRS) and Virtual Migration of Dynamic Processes across hosts. Ensure that you do
not enable the corresponding properties of the host virtual machines.
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To install the Control Room in a cluster setup, do the following steps:
1. Select the Enable Cluster Setup check box.

The check box is enabled by default if the machine on which the setup is being run has local IP
addresses configured.
To install the Control Room on a single node and not a cluster, clear the Enable Cluster Setup check
box.

2. Enter the IP addresses of the nodes in the cluster.
a) Use a comma (,) to specify more than one IP address.

For example, to specify three IP addresses in the cluster, enter:
192.0.2.1,192.0.2.2,192.0.2.3

Важное замечание:  The first IP address in the list is used as the master node. Ensure
that you enter the IP addresses in the same order on all node configurations in subsequent
installations. An incorrect order causes the application to configure the IP addresses as separate
clusters, which will result in data loss when the issue is fixed after installation.

You can install multiple nodes at the same time after the master node is initially installed.
After installation, you can add a new IP address to the cluster at the end of the list.

b) After you enter the cluster IP addresses correctly, select a valid address IP at the message prompt
to provide network access to the machine.

3. Click Next to configure the application Transport Layer Security (TLS).
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4. In the TLS Configuration page, configure the following:
• Generate a Self-Signed Certificate

Enabling the Self-Signed Certificate option allows the installer to generate a unique private key
and a self-signed certificate for the Control Room.

• Import a Certificate
To import a custom certificate, clear the Self Signed Certificate check box. This setting allows
you to import a certificate using the Certificate Path field.

Прим.:  The certificate file must be a PKCS12 format.

Provide the following information:
• Certificate Path: Click Browse to import the certificate.
• Private Key Password: Enter the password for the private key.

Password limitation:  Do not use the at sign (@) in passwords. Using the special character @
in the password causes the certificate file import to fail.

• Webserver Port: Enter the web server port – either HTTP or HTTPS. If the port is already
assigned, an error message is displayed.

Важное замечание:  The port validation message is also displayed when you add 8080
for the web server and if that port is already in use for a Control Room license service. Use a
different unassigned port in these cases.

• Enable Force HTTP traffic to HTTPS: This option redirects all HTTP port requests to HTTPS.
To access to the Control Room through HTTPS using the generated self-signed certificate,
ensure the port numbers are different for HTTP and HTTPS.
To generate a custom certificate for HTTPS, ensure your custom certificate meets the following:
• Create a .pfx certificate with a pass code from a CA trusted authority.
• Combine Root, Intermediate, and Machine level certificates into a single certificate.
• Use the format [WS Machine Host Name].[DomainName].com for the private key.
• Include the host name as a fully qualified domain name (FQDN) in the certificate.

You provide the host name during Control Room installation.
• In multi-node HA clusters, issue certificates to the load balancer DNS name.
• Add individual URLs, which require access to all nodes, to the Subject Alternative

Name field in the certificate.

For more information, see Automation Anywhere support site: Automation 360 On-Premises
prerequisites (A-People login required).

5. Click Next to configure the service credentials.
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6. In the Service Credentials screen, choose from the listed options.
The Windows Service credentials include a user name and password. The user specified must meet
these requirements:
• A member of the local system administrator group.
• Have permission to manage services, including Automation Anywhere services.
• If you use Windows authentication to connect to the SQL database, ensure you grant the

db_owner permission to the service credential user.

These service credentials allow the Control Room processes to run the required services.
• Local System Account—(default) The logged-on user performing the installation
• Domain Account—Specify a user that is not the local system account user

a. Clear the Local System Account check box.
b. Enter the user name and password for the domain account.

Для имени пользователя и пароля используйте только поддерживаемые символы. См.
раздел Supported special characters.

• Do not use the Windows domain credentials
Enter credentials valid for running Automation Anywhere services. Without the valid credentials,
the Control Room will fail to launch.

• PowerShell script restrictions
Specify a user with permissions to launch PowerShell scripts who is not a Windows domain user.
Without the relevant permissions, database table creation can fail.

7. Click Next to configure database type and server.
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8. Установите подключение и аутентификацию для сервера базы данных.

Прим.:
• По возможности не устанавливайте для параметра Сервер базы данных значение

localhost. Если необходимо использовать localhost, обратите внимание на то, что
Безопасное подключение к базе данных не будет работать.

• Щелкните Обзор, чтобы выбрать экземпляр Сервер SQL, в котором будет создана база
данных Control Room. Либо же введите имя сервера базы данных или выберите его из
списка.

Задача миграции. Если вы выполняете миграцию с Enterprise 11 на Automation 360, перейдите
к восстановленной базе данных Enterprise 11.
Укажите следующие сведения:
a) Порт базы данных: Используйте порт по умолчанию (1433) или укажите

пользовательское значение.
Configure default database port

b) Использовать безопасное подключение. Выберите этот вариант, чтобы использовать
сертификат ЦС, как указано.

Прим.:  Используйте одно и то же имя хоста для подключений сертификата и базы данных.

c) Сертификат: Этот параметр включается, когда вы выбираете Использовать безопасное
подключение. Выполните обзор для выбора сертификата ЦС.
Import HTTPS,and CA certificates

d) Аутентификация Windows. Этот параметр выбран по умолчанию и позволяет
подключаться к Сервер SQL с использованием аутентификации Windows.

Прим.:  Если вы выбрали аутентификацию Windows, то пользователь, запускающий
установщик, будет проверять существование базы данных, создавать ее при необходимости
и предоставлять db_owner пользователю учетной записи службы (NT Authority/System).

e) Аутентификация SQL Server: Select this option to use Сервер SQL authentication to connect
to the database. Укажите правильное имя пользователя и пароль для аутентификации SQL.
Для имени пользователя и пароля используйте только поддерживаемые символы. См.
раздел Supported special characters. Не используйте в пароле базы данных точку с запятой
( ; ).

f) Имя базы данных Control Room: Введите имя базы данных Control Room.
Задача миграции. Если вы выполняете миграцию с Enterprise 11 на Automation 360,
введите имя восстановленной базы данных в поле базы данных, как показано на
приведенном ниже изображении.

© 2023 Automation Anywhere. All rights reserved.     945



    Automation Anywhere - Install and update Automation 360

9. Щелкните Вперед.
10. On the Ready to Install the Program, click Install and allow the installation process to complete.
11. On the InstallShield Wizard Completed page, click Finish.

Launch Automation Anywhere is enabled by default.
Enable Show installer settings to open the aae-installsummary.html file. By default, this is
located at C:\Program Files\Automation Anywhere\Enterprise\. Use this file to view a
summary of the installation.

The Control Room launches in your default browser with the Configure Control Room settings page shown.
Continue with Configure settings post-installation on Microsoft Azure.

Configure settings post-installation on Microsoft Azure
After Control Room installation is complete, use the Microsoft Azure Portal to configure the clusters. Use
the Azure Portal to configure Windows credentials, Control Room settings for repository and URL, master
key for Credential Vault, Active Directory authentication, and optionally SMTP settings.
• If you have not done so already, complete the installation steps in Customize Control Room installation on

Microsoft Azure.
• The service account user must have read and write access for the Azure data drive (SMB).

Прим.:  There are many possible system configurations and requirements. These installation steps do
not account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.

1. From the Azure Portal where SMB File Share is setup, get the Connection String to retrieve following
parameters:
• Internet or network address
• Имя пользователя
• Пароль

2. Locate the Window Credential Manager on the control room server and click Add a Windows
Credential.
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3. Enter the credential information.

Прим.:  Adding a user under Windows Credential Manager needs to be repeated on all the servers
used for testing in the cluster environment (Control Room, Clients/Devices).

4. Enter information and click Save and Continue.
Repository path is extracted from SMB File Share and Control Room access URL in is a load balancer
Public IP.

5. Copy the Master Key and save it (it will be needed to restart the services).
6. Select Express mode and click Save and Continue.
7. Enter the Active Directory authentication configuration information, including URL, Domain username,

and password, then click Check Connection. If settings are correct, click Next.
8. Enter the AD user created previously and click Check name in Active Directory. Upon validation,

click Save and Log in.
Create additional users as needed and create corresponding users in the Control Room.

9. Необязательно: Continue with installing other control room nodes in the cluster.
10. Perform the SMTP registration.

Прим.:  A real SSL certificate is recommended for use with deployments.

This completes the Control Room installation on Microsoft Azure.

If you see a Bad Gateway error message after you install the Control Room in a three-node cluster setup
with S0 Azure SQL Database, see the following article for troubleshooting steps.
Automation A360 - Bad Gateway error in a three node cluster setup (A-people login required)

Complete the Control Room configuration and validation.
• Complete Control Room post-installation configuration

After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.

• Post-installation user management

After completing the post-installation tasks, validate the setup by logging in to the Control Room and
installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.

• Пользователи
As a Cloud user with administrator permissions, you can create, view, edit, delete, and enable or disable
a user. Creating users steps vary depending on whether the user is a non-Active Directory, Active
Directory, or single sign-on (SSO) user from an IdP server.

Installing Control Room on Google Cloud Platform
Log in to a Google Cloud Platform (GCP) server instance as administrator. Then download and start the
Control Room installer and install in Custom mode.
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Прим.:  There are many possible system configurations and requirements. These installation steps do
not account for all those possibilities so your specific setup and installation steps will vary and Automation
Anywhere does not make any warranties that these steps conform with your specific configurations.

1. Complete the prerequisites for installation:
• Verify Automation 360 On-Premises prerequisites.
• Убедитесь в том, что у вас есть следующее.

• Automation Anywhere Control Room installation file
• TLS certificate
• License file

2. Prepare to install Control Room on Google Cloud Platform

Ensure that you complete the required steps to prepare the Google Cloud Platform instances for
installing the Control Room.

3. Perform custom installation of Control Room on Google Cloud Platform

Install and apply the customized configuration required for the Control Room cluster on Google Cloud
Platform after completing initial preparations.

4. Configure Google Cloud Platform settings after installation

After installing the Control Room, configure the required settings on Google Cloud Platform.
5. Complete the Control Room configuration and validation.

a) Complete Control Room post-installation configuration

After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.

b) Post-installation user management

After completing the post-installation tasks, validate the setup by logging in to the Control Room
and installing a license. First time access to the Control Room walks you through the configuration
for your authentication method.

6. Manage your users

As a Cloud user with administrator permissions, you can create, view, edit, delete, and enable or
disable a user. Creating users steps vary depending on whether the user is a non-Active Directory,
Active Directory, or single sign-on (SSO) user from an IdP server.

Совет:  To ensure that the bots run properly in GCP, we recommend that you create a whitelist for
the following APIs:
• /v2/repository/files/:id/content
• /v2/repository/files/public/:id/content
• /v2/blm/import
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Prepare to install Control Room on Google Cloud Platform
Ensure that you complete the required steps to prepare the Google Cloud Platform instances for installing
the Control Room.
1. Configure the Network Security Group of all the servers as specified in the following list:

• Name: aarestrictedsecuritygroup
• Type: Ingress
• Targets: aarestrictedsecuritygroup
• Filters: IP ranges: List of IP addresses provided by the IT security team
• Protocols and ports: all
• Action: Разрешить
• Priority: 1000
• Network: default

Прим.:  In the IP address ranges field, enter all the IP addresses of all the virtual machines (VMs) in
the cluster environment.

2. Set up the F5 load balancer with the following configurations:
• Select standard as the type option.
• Enter 0.0.0.0/0 as the Source address in Host.
• Enter F5-LB-Private IP as the Destination Address/Mask in Host.
• Enter 80 as the Port and select HTTP as the Service Port.
• Select the Notify Status to Virtual Address check box.
• Enable the load balancer state.

To use SSL offload with the F5 load balancer, provide the SSL certificate at the load balancer level,
and configure your Control Room application servers to use HTTP mode only.

Прим.:  Your IT team should configure the F5 load balancer with the Control Room.

3. Set up pools and nodes with the following configurations:
a) Update the pool properties:

• Choose a basic configuration.
• Select ICMP as your gateway to monitor health.

b) Update the pool member options:
• Choose the round-robin method for load balancing.
• Disable the priority group activation.

c) Update the node properties:
• Change the state to enabled.
• Select node-specific health monitors.
• Select ICMP as your gateway to monitor health.

4. Configure the Active Directory server.
Verify that all the VMs in the cluster can ping each other using private IP addresses.
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5. Connect using RDP to one of the Control Room nodes or servers and run the Control Room installer.
The Installation Prerequisite Check verifies that your system has the basic configurations required for
Automation Anywhere. См. раздел Automation 360 On-Premises prerequisites.

Perform custom installation of Control Room on Google Cloud Platform

Perform custom installation of Control Room on Google Cloud Platform
Install and apply the customized configuration required for the Control Room cluster on Google Cloud
Platform after completing initial preparations.
If you have not done so already, complete the initial installation steps: Prepare to install Control Room on
Google Cloud Platform.
1. Log in to the first Google Cloud Platform instance as an administrator.
2. Download the Automation Anywhere__<version>.exe file.

A-People Downloads page (Login required)

3. Run the installer file.
4. Click Next on the Welcome to the Setup Wizard page.
5. Accept the licensing agreement and click Next.
6. Выберите вариант Пользовательский и щелкните кнопку Далее.

The Destination Folder page appears. By default, the destination folder is C:\Program Files
\Automation Anywhere\Enterprise\.

7. To make changes to the destination folder, click Change, enter a new destination folder name, and
click OK.

Прим.:  Do not install the application directly in the root directory (C:\). You should create a folder,
for example, C:\Program Files\Automation Anywhere\Enterprise\.

8. Click Next to configure the IP cluster.
9. Select the Enable Cluster Setup check box.

The check box is enabled by default if the machine on which the setup is being run has local IP
addresses configured.
To install the Control Room on a single node and not a cluster, clear the Enable Cluster Setup check
box.

10. Enter the IP addresses of the nodes in the cluster.
• Enter IPv6 addresses if all the nodes in the network are using IPv6.
• Enter IPv4 addresses if some nodes in the network are using a combination of IPv4 and IPv6

addresses.

a) Use a comma (,) to specify more than one IP address.
For example, to specify three IP addresses in the cluster, enter:
192.0.2.1,192.0.2.2,192.0.2.3

Важное замечание:  The first IP address in the list is used as the master node. Ensure
that you enter the IP addresses in the same order on all node configurations in subsequent
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installations. An incorrect order causes the application to configure the IP addresses as separate
clusters, which will result in data loss when the issue is fixed after installation.

You can install multiple nodes at the same time after the master node is initially installed.
After installation, you can add a new IP address to the cluster at the end of the list.

b) After you enter the cluster IP addresses correctly, select a valid address IP at the message prompt
to provide network access to the machine.

11. Click Next to configure the application Transport Layer Security (TLS).
12. In the TLS Configuration page, configure the following:

• Generate a Self-Signed Certificate
Enabling the Self-Signed Certificate option allows the installer to generate a unique private key
and a self-signed certificate for the Control Room.

• Import a Certificate
To import a custom certificate, clear the Self Signed Certificate check box. This setting allows
you to import a certificate using the Certificate Path field.

Прим.:  The certificate file must be a PKCS12 format.

Provide the following information:
• Certificate Path: Click Browse to import the certificate.
• Private Key Password: Enter the password for the private key.

Password limitation:  Do not use the at sign (@) in passwords. Using the special character @
in the password causes the certificate file import to fail.

• Webserver Port: Enter the web server port – either HTTP or HTTPS. If the port is already
assigned, an error message is displayed.

Важное замечание:  The port validation message is also displayed when you add 8080
for the web server and if that port is already in use for a Control Room license service. Use a
different unassigned port in these cases.

• Enable Force HTTP traffic to HTTPS: This option redirects all HTTP port requests to HTTPS.
To access to the Control Room through HTTPS using the generated self-signed certificate,
ensure the port numbers are different for HTTP and HTTPS.
To generate a custom certificate for HTTPS, ensure your custom certificate meets the following:
• Create a .pfx certificate with a pass code from a CA trusted authority.
• Combine Root, Intermediate, and Machine level certificates into a single certificate.
• Use the format [WS Machine Host Name].[DomainName].com for the private key.
• Include the host name as a fully qualified domain name (FQDN) in the certificate.

You provide the host name during Control Room installation.
• In multi-node HA clusters, issue certificates to the load balancer DNS name.
• Add individual URLs, which require access to all nodes, to the Subject Alternative

Name field in the certificate.

For more information, see Automation Anywhere support site: Automation 360 On-Premises
prerequisites (A-People login required).

13. Click Next to configure the service credentials.
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14. In the Service Credentials screen, choose from the listed options.
The Windows Service credentials include a user name and password. The user specified must meet
these requirements:
• A member of the local system administrator group.
• Have permission to manage services, including Automation Anywhere services.
• If you use Windows authentication to connect to the SQL database, ensure you grant the

db_owner permission to the service credential user.

These service credentials allow the Control Room processes to run the required services.
• Local System Account—(default) The logged-on user performing the installation
• Domain Account—Specify a user that is not the local system account user

a. Clear the Local System Account check box.
b. Enter the user name and password for the domain account.

Для имени пользователя и пароля используйте только поддерживаемые символы. См.
раздел Supported special characters.

• Do not use the Windows domain credentials
Enter credentials valid for running Automation Anywhere services. Without the valid credentials,
the Control Room will fail to launch.

• PowerShell script restrictions
Specify a user with permissions to launch PowerShell scripts who is not a Windows domain user.
Without the relevant permissions, database table creation can fail.

15. Add the Сервер SQL and click Next.
Select Microsoft SQL Server, enter the name, and click Next.

16. On the InstallShield Wizard Completed page, click Finish.
Launch Automation Anywhere is enabled by default.
Enable Show installer settings to open the aae-installsummary.html file. By default, this is
located at C:\Program Files\Automation Anywhere\Enterprise\. Use this file to view a
summary of the installation.

The Control Room is opened in your default browser and displays the Configure Control Room settings
page.
Configure Google Cloud Platform settings after installation

Configure Google Cloud Platform settings after installation
After installing the Control Room, configure the required settings on Google Cloud Platform.
If you have not done so already, complete the installation steps: Perform custom installation of Control Room
on Google Cloud Platform.
1. Configure the following Control Room settings:

a) Specify the host name URL by providing the Google Cloud Platform load balancer URL.
This is the URL that users use to access the Control Room.

b) Select the Active Directory authentication type.
См. раздел Configure Control Room for Active Directory: manual mode.
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2. After you configure the Control Room, install product licenses.
3. Test access to the Control Room using the Google Cloud Platform load balancer URL.

Complete the Control Room configuration and validation.
• Complete Control Room post-installation configuration

After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.

• Post-installation user management

After completing the post-installation tasks, validate the setup by logging in to the Control Room and
installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.

• Пользователи
As a Cloud user with administrator permissions, you can create, view, edit, delete, and enable or disable
a user. Creating users steps vary depending on whether the user is a non-Active Directory, Active
Directory, or single sign-on (SSO) user from an IdP server.

Installing Control Room on Linux
You start installing the Automation Anywhere Control Room in the Linux environment and complete the
installation in the Control Room.

Прим.:  The installation steps do not list any specific configurations or requirements and therefore your
setup might be different. Automation Anywhere does not provide any warranties that the installation steps
conform with your system configurations or requirements.

This task applies to first-time installation and updates of Automation 360 On-Premises.

Ensure the following:
• The Microsoft SQL Server or Oracle Server database is installed and running.
• The Automation 360 installation server is connected to the Microsoft SQL Server or Oracle Server

database.
• For Oracle Server, ensure that you have installed the appropriate JDBC driver for the Oracle version that

is connected to the Control Room.
• From Automation 360 Сборка 6463, ensure that Python 3.6 is installed.
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• For Oracle Server, only non-container database is supported.

1. Verify the installation prerequisites.
a) Verify the Automation 360 On-Premises prerequisites.
b) Depending on the server you want to use, verify that the Microsoft SQL Server or Oracle Server is

running, and execute the command:
$ sudo systemctl status mssql-server

If Microsoft SQL Server is not running, install it.

Прим.:  The Microsoft SQL Server or Oracle Server installation instructions refer to Red Hat
Enterprise Linux version 8. For version 7, change the paths to /rhel/7 instead of /rhel/8.

См. раздел Quickstart: Install SQL Server.
c) Ensure the following files are available:

• SSL certificate
• License file

d) Download the Automation360_el7_Build_<build_number>.bin installation file to the
Linux server from A-People Downloads page (Login required)

Прим.:  We do not support the patch upgrades (upgrading between builds in the same release)
in Linux. When you are performing a patch upgrade, we recommended that you always uninstall
and do a fresh install for the patch upgrades.

e) Verify that the installation server has internet access in order to update Linux kernel files and OS
libraries using Yum updates.
Alternatively, configure /etc/yum.conf on the installation server to use a Yum repository local
to its network. The Yum repository should be up to date before starting the installation.

f) Starting in Automation 360 Сборка 6463, Python 3.6 is required.

2. Log in to the installation server.
3. Run the installer command as a superuser from the Linux shell:

a) $ sudo chmod +x Automation360_el7_Build_<build_number>.bin

b) $ sudo ./Automation360_el7_Build_<build_number>.bin

The installation wizard verifies the installation requirements and proceeds with the installation.

Совет:
• Enter the back command to return to a previous command step.
• Press the return key to accept default values, or enter an alternate value and then press the

return key.

4. To accept the license agreement, enter Y.
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5. In the Transport Layer Security (TLS) screen, configure the following:
a) Control Room HTTP Port (Default: 80)

b) Control Room HTTPS Port (Default: 443)

c) To enable the Self Signed Certificate, enter 1 or enter 2 to disable it.
d) To Force HTTP Traffic to HTTPS, enter 1 to disable it or enter 2 to enable it.

Configure application Transport Layer Security

6. In the Cluster Configuration screen, enter 1 to disable it or enter 2 to enable it.
• If you choose to enable cluster configuration, enter the IP addresses of the cluster nodes. Use a

comma (,) to specify more than one IP address. Do not add space between IP addresses. Пример.
192.168.0.1,192.168.0.2,192.168.0.3

• The repository location should be a shared location accessible from all Control Room nodes in the
cluster.

• Ensure that you select the IP address that is used to communicate with other nodes of the Control
Room.

Настроить IP-кластер
7. In the Database Type screen, select one of the following servers:

• Microsoft SQL Server
• Oracle

8. Depending on the database server you chose, configure the following settings the server:

Microsoft Databse Configuration Oracle Databse Configuration

Database Server address
 (default: localhost)

Database Server (default:
 localhost)

Database port (default: 1433) Database port (default: 1521)

Control Room Database (default:
Automation360-Database) or enter a
name.

Connect with SID or Service Name

Прим.:  The SID and Service Name entered
in the text field provided is unique to your
Oracle database.

SQL Server Login credentials:
provide the login ID and Сервер SQL
password.

Database User/Schema Password:
provide the password.

Password prompt for
 elasticsearch: Enter or define any
password.

(Optional) Use Secure Connection:
Enable to use a CA certificate as specified
and select a CA certificate.

Прим.:  Используйте одно и то же имя
хоста для подключений сертификата и
базы данных.

Import HTTPS and CA certificates
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9. In the Database Configuration screen, configure the following:
a) Database Server address (default: localhost)

b) Database port (default: 1433)

c) Control Room Database (default: Automation360-Database) or enter a name.
d) SQL Server Login credentials: provide the login ID and Сервер SQL password.
e) Password prompt for elasticsearch: Enter or define any password.

10. Review the pre-installation summary.
11. Press Enter to install Automation 360 in the default directory.

Linux installer Версия Default directory path

Version .22 and earlier
versions

Updating from earlier
versions to version .22

/opt/
automationanywhere/
enterprise

Installation file path

New installation of
version .22 and later

/opt/
automationanywhere/
automation360

A message appears stating the installation is successfully completed. See Installed Control Room
directories and files for the location of control room assets.

12. Configure the post-installation settings.
Configuring post-installation settings

Post-installation, a Control Room group controlroom is automatically created. Following users are a
part of this group which run the respective Control Room services:
crkernel, traefik, ignite, activemq, crelasticsearch, criqbot, crbotinsight,
craari, crdiscoverybot, crstorage, crdiscoverybotml.

13. Verify Automation 360 services started successfully.
Stop and start Control Room services on Linux

14. Set up Control Room access.
Настройка базы данных Control Room

15. Set up licenses.
Installing additional licenses

16. The log files for the Control Room installation are available at:

Linux installer Версия Log file path

Version .22 and earlier
versions

Updating from earlier
versions to version .22

/var/log/
automationanywhere/
enterprise

Log path

New installation of
version .22 and later

/var/log/
automationanywhere/
automation360

After the Control Room installation and configuration is complete, users can register their devices to create
and run боты.
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Установка Bot Agent и регистрация устройств
For more information on Out of Memory Management (OOM Killer), see Linux Automation 360 Control Room
service stopped (A-People login required).
Задачи, связанные с данной
Performing silent installation of Control Room on Linux
Silent Control Room installation, also known as unattended installation, uses a customized script with
parameters specific to your business requirements. The entire installation process runs in the background
without requiring user interaction or displaying messages.
Uninstall Automation 360 On-Premises from Linux server
Uninstall the On-Premises Control Room from your Linux server.
Ссылки, связанные с данной
Installing Control Room On-Premises
Review the installation core tasks and topics for installing the Automation 360 Control Room in a data
center on an On-Premises server or a cloud service provider server instance.
Control Room repository requirements
The repository location is configured in the Control Room after installation. All your automations are stored
in this repository.

Performing silent installation of Control Room on Linux
Silent Control Room installation, also known as unattended installation, uses a customized script with
parameters specific to your business requirements. The entire installation process runs in the background
without requiring user interaction or displaying messages.
• Verify you have completed the Automation 360 On-Premises prerequisites.
• Убедитесь в том, что у вас есть следующее.

• Automation Anywhere Control Room installation file
• SSL certificate
• License file

• Verify the installation server has internet access in order to update Linux kernel files and OS libraries
using Yum updates. Alternatively, configure /etc/yum.conf on the installation server to use a
repository local to its network. The repository should be up to date before starting the installation.

Two scripts run the Linux silent installation:
• LinuxInstaller.sh: This script contains the installation parameters you want to apply during

installation.
• CallLinuxScript.sh: This script executes the first script.

See the installation parameters and sample scripts.
Run the script in Linux shell.
1. Review the parameters and identify the settings you require.

Control Room installation parameters

Installation parameter Описание Script response options

Proceed with Installation The installer analyzes your
system and notifies you
if it does not meet the
prerequisites. In silent mode,
set the value to 1.

1 = Continue
2 = Cancel
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Control Room installation parameters

Installation parameter Описание Script response options

Continue setup wizard The installer displays an
introduction and offers
options of back to return to
a previous step and quit to
cancel the installation.
Default is Enter.

\n

Advance to end of License
Agreement

In console mode, you have
the option to page through
the license agreement. In
silent mode, you advance to
the end by selecting 0.

0

Accept License Agreement Accept the license
agreement to continue with
the installation. In silent
mode, set the value to Y.

Y = Yes
N = No

Control Room HTTP Port The web server port you will
use to access the Control
Room with HTTP. The default
value is 80.
Replace the number 80 in
the sample script to use a
different port.

80 = Default port
yy = your port number yy

Control Room HTTPS Port The web server port you will
use to access the Control
Room with HTTPS. The
default value is 443.
Replace the number 443 in
the sample script to use a
different port.

443 = Default port
zzz = your port number zzz

TLS configuration: Self-
Signed Certificate

Choose to enable or disable
the self-signed certificate.
The default is Enable, or 1.

1 = Default (Enable)
2 = Disable

TLS Configuration: Force
HTTP traffic to HTTPS

Choose to disable or enable
forcing traffic from HTTP
to HTTPS. The default is
Disable.

1 = Default (Disable
2 = Enable

Cluster setup Choose to disable or enable
clustering. The default is
Disable.

1 = Default (Disable)
2 = Enable

Database server URL server1.yourcompany.com Enter the URL of the server
where the database resides.

Database server port Default is 1433 1433
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Control Room installation parameters

Installation parameter Описание Script response options

Имя базы данных Default is localhost Default is localhost. If
database is on a separate
server, enter the host name.

Database SA user name Database system
administrator login ID

Default is sa.

Database SA user password Database system
administrator login ID

The password to log in to
your database as system
administrator user.

Database Secure Connection Choose to disable or enable
the connection. Default is
Disable (1).

1 = Default (Disable)
2 = Enable

Pre-Installation summary If the output is directed to
a console, the installer will
show a summary of features
selected and whether the
prerequisites are met.
Default is Enter

\n

Proceed Confirm to proceed with
the installation. Default is
Enter.

\n

2. Create the script LinuxInstaller.sh, substituting values for your own environment.

Важное замечание:  Be sure to test the connection to the Сервер SQL and enter verified values
for database name, database administrator login ID, database administrator password. Invalid values
cause the script to stall and fail.

Example script:

echo "Starting Installation"
#Change the next two lines to match the install filename you downloaded
sudo chmod a+x AutomationAnywhereEnterprise_A2019_el7_4799.bin 
sudo ./AutomationAnywhereEnterprise_A2019_el7_4799.bin  << EOF
1
\n
0
Y
80
443
1
1
1
#Change the next line to your Automation Anywhere install server
mybotserver.mycompany.com
1433
#Replace next line with your database name
AAE-Database
#Change the next two lines to your SQL Server admin ID and password
admin
youradminpasswordhere
1
\n
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\n
\n
EOF

3. Create the script CallLinuxscript.sh to execute Linuxinstaller.sh.
This script writes the installation results to /home/Installlog. Change the path to the install log
file, if required.

echo "Starting Linux installation"
sudo ./LinuxInstaller.sh >> /home/Installlog
echo "Installation Completed Successfully"

4. On the installation server, logged in as an Administrator, execute the scripts.
a) $ sudo chmod a+x LinuxInstaller.sh

b) $ sudo chmod a+x CallLinuxscript.sh

c) $ sudo ./CallLinuxscript.sh

5. Review the installation log to confirm there were no errors.

Прим.:  The Control Room installation folder on Linux is located by default at /opt/
automationanywhere/enterprise.

Continue from the step Configure the post-installation settings in
Installing Control Room on Linux.

Uninstall Automation 360 On-Premises from Linux server
Uninstall the On-Premises Control Room from your Linux server.
Ensure that the Automation 360 installation server is disconnected from the Microsoft SQL Server
database.
1. Log in to the installation server.
2. Run the uninstaller command as a superuser:

$ sudo /opt/automationanywhere/enterprise/_Automation\ Anywhere\
 Enterprise_installation/Change\ Automation\ Anywhere\ Enterprise\
 Installation

The installation wizard verifies the installation and proceeds with the uninstallation.

Совет:
• Enter the back command to return to a previous command step.
• Press the return key to accept default values, or enter an alternate value then press the return

key.

3. Confirm the uninstallation by entering Y.
The Automation 360 components are removed from the Linux system.
The databases with associated Automation 360 information about users and боты remains stored in
the database and remain connected to any other Control Room in your cluster.
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Performing silent uninstallation of Control Room on Linux
Use the sample script to perform an unattended uninstallation of Control Room.
Ensure that the Automation 360 installation server is disconnected from the Microsoft SQL Server
database.
1. Log in to the installation server.
2. Create a shell script named LinuxUninstall.sh that will run the uninstallation process and

automatically respond to prompts:

sudo /opt/automationanywhere/enterprise/_Automation\ Anywhere\
 Enterprise_installation/Change\ Automation\ Anywhere\ Enterprise\
 Installation << EOF
\n
1
\n
EOF

3. Mark the script as executable and run the uninstallation process.
a) $ sudo chmod a+x LinuxUninstall.sh

b) $ sudo ./LinuxUninstall.sh

The script is executed:

===============================================================================
Automation Anywhere Enterprise                   (created with
 InstallAnywhere)
-------------------------------------------------------------------------------
Preparing CONSOLE Mode Uninstallation...

===============================================================================
Uninstall Automation Anywhere Enterprise
----------------------------------------

About to uninstall...

4. When the uninstallation is complete, manually remove any remaining files.

Configure Control Room in cluster setup with shared repository for Linux
As an RPA platform administrator, you can configure the Control Room in a cluster setup across a shared
repository to achieve high availability, load balancing, and disaster recovery.
• Verify whether the prerequisites for on-premises installation are met.

Automation 360 On-Premises prerequisites
• Убедитесь в том, что у вас есть следующее.

• Three Linux VMs with RHEL 7.9
• One Linux VM with MS SQL 2019 connected to a database
• One load balancer with access to all the nodes
• One AWS NFS

If one of the Control Room nodes is down, the other nodes maintain continuity of service and manage
the load on the server. If a specific node fails, data can be recovered from the other shared nodes on the
server.

© 2023 Automation Anywhere. All rights reserved.     961



    Automation Anywhere - Install and update Automation 360

Perform the following steps to configure the Control Room in a cluster that has three nodes (N1, N2, and
N3) using a shared repository.
1. Set up the NFS in AWS.
2. Create a directory in the nodes N1, N2, and N3.

/CRRepo/AutomationAnywhere

3. Run the following commands to grant the read and write permissions to the new directory across all
the nodes:
a) sudo chown -R crkernel:controlroom /CRRepo/AutomationAnywhere

b) sudo chmod -R 775 /CRRepo/AutomationAnywhere

4. Run the following command in all the three nodes to edit the fstab file to mount and map the new
directory with NFS.
fs-eec88e3f.efs.ap-south-1.amazonaws.com:/ /CRRepo/AutomationAnywhere nfs
 rw,hard,intr,rsize=1048576,wsize=1048576,timeo=14 0 0

5. To verify that the remote NFS volume is successfully mounted, reboot nodes N1, N2, and N3, and run
the df -h command.
After the share is mounted, the mount point becomes the root directory of the mounted file system.

6. To verify that the NFS is working across the shared repository, create a text file in the /CRRepo/
AutomationAnywhere directory of node N1.
You can view the same file in the nodes N2 and N3 directory.

7. Install Control Room in the nodes N1, N2, and N3.
Installing Control Room on Linux

After Control Room is configured across the shared repository, perform the following steps:
1. Access Control Room through the load balancer URL.
2. Continue with the following steps after the Control Room configuration steps.

a. In the Control Room repository path, enter /CRRepo/AutomationAnywhere.
b. In the URL field, enter the load balancer server URL.
c. Complete steps required to create an admin user.

3. Verify the Control Room on all the three nodes by navigating to the Administration > Settings >
General tab.

Add nodes to a cluster setup for Linux
As an RPA platform administrator, you can add nodes to a cluster for better performance and better load
distribution.
Ensure the following:
• Verify whether the prerequisites for on-premises installation are met.

Automation 360 On-Premises prerequisites
• Verify that all the primary nodes and databases have backups.
• You must have the IP addresses of all the cluster members for the Control Room server network

interfaces used for Elasticsearch communications.

Прим.:  The Control Room servers can have multiple network interfaces. The server IP addresses must
be statically assigned and cannot use the Dynamic Host Configuration Protocol (DHCP).
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• If any external load balancers are used in the environment, update them with IP addresses from the
new server nodes.

• Ensure that you have administrator or root privileges on the Control Room servers. You must be familiar
with installing Control Room in custom mode and also with the related configuration settings.

Adding nodes to a cluster helps you to upgrade the configuration of the nodes in a cluster. You can add
nodes to a Control Room cluster setup, change the IP addresses of nodes in the cluster, and monitor the
health of the underlying cluster services.

Прим.:  The minimal number of nodes supported within a Control Room cluster is three. The nodes in a
cluster synchronize with each other over a local network. All the nodes in a cluster connect to the same
database.

Perform the following steps to add three nodes (N4, N5, and N6) to a cluster that has three nodes (N1, N2,
and N3).
1. On node N4, run the installer command as a superuser from the Linux shell:

$ sudo ./Automation360_el7_Build_<build_number>.bin

2. Proceed through the installer to the cluster configuration.
a) Select Enable Cluster Setup.
b) In the Cluster IP addresses box, enter the IP addresses of all the nodes that you need to

configure in the cluster.

172.31.30.120, 172.31.21.216, 172.31.17.110, 172.31.20.242, 172.31.17.149,
 172.31.18.37

Прим.:  The IP addresses must be entered in the same sequence on every node.

3. Complete the remaining steps to install Control Room.
Installing Control Room on Linux

4. Repeat the steps 1 through 3 for nodes N5 and N6.
5. Add the complete set of IP adrresses for all the nodes in the older nodes N1, N2, and N3.

Restart the nodes, one at a time.
6. To verify the health of the cluster, run the following commands in the command line:

a) curl -k --user es_client:<es password> https://172.31.30.120:47599/_cat/
nodes

The master node is indicated by an asterisk character (*).
b) Verify that the IP address of the master node is the same as the one mentioned in the

elasticsearch.yml file for all the nodes.
c) curl -k --user es_client:<es password> https://172.31.30.120:47599/_cat/

health?pretty

You must wait until the replication status turns green. The replication time varies depending on the
data load in the clusters. The replication status turns green when the cluster is fully synchronized.

Remove nodes from a cluster setup for Linux
As an RPA platform administrator, you can remove nodes from a Control Room cluster setup to replace
them or upgrade them for enhanced performance.
Ensure the following:
• Verify that all the primary nodes and databases have backups.
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• Ensure that you have administrator or root privileges on the Control Room servers.

Perform the following steps to remove three nodes (N1, N2, and N3) from a cluster that has six nodes (N1,
N2, N3, N4, N5, and N6).
1. Run the following command in the Linux shell to identify the master node.

curl -k --user es_client:Automation123 https://172.31.46.2:47599/_cat/nodes

2. Remove the non-master nodes N2 and N3 from the cluster.
a) Log in to the server as an administrator and run the following command to stop all the Control

Room services.
sudo systemctl stop controlroom*

b) Log in to any of the non-master nodes.
c) Edit the cluster.properties file located at /opt/automationanywhere/automation360/

config.
d) Remove the IP addresses for the original three nodes.

Прим.:  Perform this action for all the nodes in the cluster. When you remove the IP addresses of
the original three nodes, do not change their sequence.

e) Edit the elasticsearch.yml file at /opt/automationanywhere/automation360/
elasticsearch/config.

f) Remove the old IP addresses from the list in the discovery.zen.ping.unicast.hosts attribute.
g) Restart the non-master nodes, one at a time.

3. Remove the master node N1 from the cluster.
a) Log in to the server as an administrator and run the following command to stop all the Control

Room services.
sudo systemctl stop controlroom*

b) Log in to the any of the non-master nodes.
c) Edit the cluster.properties file and remove the IP address of the old master node.
d) Run the following command in any of the other nodes to identify the new master node.

curl -k --user es_client:<es password>https://172.31.18.37/_cat/nodes

e) Edit the elasticsearch.yml file at /opt/automationanywhere/automation360/
elasticsearch/config.

f) Update the IP address of the new master node in the cluster.initial_master_nodes attribute.
g) Remove the IP address of the old master node from the list in the

discovery.zen.ping.unicast.hosts attribute.
h) Run the following command to start the services on each node:

sudo systemctl start controlroom*

4. To verify the health of the cluster, run the following command in the command line:
curl -k --user es_client:<es password>https://172.31.18.37/_cat/nodes

You must wait until the replication status turns green. The replication status turns green when the
cluster is fully synchronized.
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Installing Control Room on Microsoft Windows Server using scripts
Silent Control Room installation, also known as unattended installation, uses a customized script for a full
setup or an update setup. Silent installation runs the entire installation process in the background, without
requiring user interaction or displaying messages.
To perform the task, you must have a  administrator account with the required rights and permissions.
• Disable the User Access Control (UAC) on host VM for Control Room.
• Verify Automation 360 On-Premises prerequisites.
• Убедитесь в том, что у вас есть следующее.

• Automation Anywhere Control Room installation file
• TLS certificate
• License file

• Create a Powershell script.
See the installation parameters and sample scripts.

• Run the script in Powershell.

1. Review the parameters and identify the settings you require.
• Control Room installation parameters

Variable name Описание

AA_CRCLUSTERCONFIG if AA_SETCLUSTERMODE=1 then cluster
IP comma separated

AA_CRDBPORT Control Room database port. Default
value is 1433

AA_CRDBSSLMODE Secure SQL connection

AA_CRFORCEHTTPSCONFIG=" " --

AA_CRFORCETOHTTPS="1" Force traffic from HTTP to HTTPS

AA_CRHTTPPORT Control Room HTTP port. Default is 5432

AA_CRHTTPSPORT Control Room HTTPS port

AA_CRLISTENPORT Web server port. Default value is 80

AA_CRSERVICECONFIRMPASSWD If AA_CRSETLOCALSERVICECRED= 0,
then confirm password

AA_CRSERVICEPASSWD If AA_CRSETLOCALSERVICECRED= 0,
then confirm password

AA_CRSERVICEUSERNAME if AA_CRSETLOCALSERVICECRED= 0,
then add domain\user name

AA_CRSETLOCALSERVICECRED • 1 if service logon as System
• 0 if service logon as specific user
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Variable name Описание

AA_CRWCCERTPASSWD Certificate password

AA_CRSELFSIGNCERT 1 for self-signed certificate

AA_CRWCCERTPATH Certificate path

AA_SDSFEATURE • true=Cloud deployment type
• false=On-Premises deployment type

AA_SETCLUSTERMODE For cluster set 1, otherwise 0

AA_SETUPTYPE Setup type Custom or Express

INSTALLDIR Installation Directory

IS_SQLSERVER_AUTHENTICATION • 0 for Windows authentication
• 1 for SQL authentication
• 2 for Azure AD authentication

IS_SQLSERVER_DATABASE SQL database name

IS_SQLSERVER_SERVER SQL server name (host name)

• Elasticsearch related parameters

Параметр Описание

AA_ELASTICSEARCH_BACKUP Used only if installing on the first node of
a backup server.
Enter 1 if yes.

Прим.:  The
AA_ELASTICSEARCH_BACKUP parameter
is used when you install an Control Room
as backup server for audit.

AA_ELASTICSEARCHSYSIP Valid IP address

AA_ESPASSWD Password for Elasticsearch

Прим.:  An additional parameter for
confirming the password is not available.
The password must have a minimum of 6
characters.
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• Key-vault related parameters

Параметр Описание

AA_KEYVAULTTYPE Enter any of the following:
• NONE if you do not want to define a

key vault
• AWSS for AWS Secrets Manager
• CARK for CyberArk

IS_SQLSERVER_AUTHENTICATION Enter any of the following:
• 0 if SQL server authentication is not

set
• 1 if SQL server authentication is set

IS_SQLSERVER_EKVAUTHENTICATION Use this if the SQL server authentication
is configured for an external key vault.
Enter any of the following:
• 0 if SQL server authentication does

not use an external key vault
• 1 if SQL server authentication for a

key vault is configured for CyberArk
• 2 if SQL server authentication for

a key vault is configured for AWS
Secrets Manager

AA_CRSERVICECREDTYPE Enter any of the following:
• LOCAL if the Control Room database

uses local authentication.
• SERVICE if the Control Room

database uses custom authentication.
• SERVICEEKV if the Control Room

database uses external key vault for
authentication.

AWS Secrets Manager key vault parameters

AA_AWSSREGION AWS region

AA_DBAUTHAWSSECRET AWS sqllogin secret

AA_CRSERVAWSSECRET AWS service secret

CyberArk key vault parameters

AA_CARKAPPID CyberArk app ID

AA_CARKCERTIFICATE Full certificate filename with path

AA_CARKOPTIONALCERT Optional certificate filename with path

AA_CARKCERTPASSPHRASE Certificate passphrase

AA_CARKVAULTURL CyberArk URL

AA_DBAUTHCARKOBJECTNAME CyberArk sqllogin object name
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Параметр Описание

AA_DBAUTHCARKSAFENAME CyberArk sqllogin safe name

AA_CRSERVCARKOBJECTNAME CyberArk service credential

AA_CRSERVCARKSAFENAME CyberArk service locker

• IPv6-related parameters

Параметр Описание

AA_IPV6ENABLED Enter 1 to enable IPv6 addresses
To disable IPv6 addresses, do not enter
the parameter.

2. Необязательно: Edit the sample script to use a Microsoft SQL Server database.
Use the script to install the Control Room with the configuration options available in the installer.
a) Correct values for variables such as $service_username, $service_pwd, $db_server,

$cr_port.
b) Run the script with Credentials in Service logon, and a non-secure connection using Microsoft SQL

Server authentication with a new database.

Sample script:

$cr_port=80

$service_username= "domain\username" #e.g."aaspl-brd\ellie.brown"
$service_pwd="password"

#$certpath = "C:\SilentInstall\test256.pfx"
#$certpass = "changeit"

$db_server="localhost"
$cr_db_name="CRDB-NEW-SI-3"
$db_user="sa"
$db_pwd="Admin@123"

$elastic_password="Test@123"

$installation_path="C:\Program Files\Automation Anywhere"

#Install latest setup
$static_installation_path="\Enterprise\"""""
$silent_details=" /s ","v""" -join "/"
$installpath_details=" /qn INSTALLDIR=\"""

$deployment_details=" /AA_SDSFEATURE=true"

$custom_details=" /vAA_SETUPTYPE=Custom 
                  /vAA_CUSTOMMODETYPE=1"

$port_cluster_details=" /vAA_SETCLUSTERMODE=0 
                        /vAA_CRLISTENPORT=$cr_port"

#$service_details=" /vAA_CRSETLOCALSERVICECRED=0 
                    /vAA_CRSERVICEUSERNAME=$service_username 
                    /vAA_CRSERVICEPASSWD=$service_pwd 
                    /vAA_CRSERVICECONFIRMPASSWD=$service_pwd"
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$service_details=" /vAA_CRSETLOCALSERVICECRED=1"

#$db_details=" /vAA_BIMETADATADBTYPE=AA_BIMETADATADBTYPE 
               /vIS_SQLSERVER_SERVER=$db_server 
               /vIS_SQLSERVER_DATABASE=$cr_db_name 
               /vIS_SQLSERVER_DATABASE1=$bi_db_name"

$db_details=" /vIS_SQLSERVER_SERVER=$db_server 
              /vIS_SQLSERVER_USERNAME=$db_user 
              /vIS_SQLSERVER_PASSWORD=$db_pwd 
              /vIS_SQLSERVER_DATABASE=$cr_db_name 
              /vIS_SQLSERVER_AUTHENTICATION=1"

$other=" /vAA_ESPASSWD=$elastic_password 
         /vAA_CRWCHTTPPORT=80 
         /vAA_CRWCHTTPSPORT=443 
         /vAA_CRSELFSIGNCERT=1 
         /vAA_OPTIONALCACERT=0 
         /vAA_CRWCCERTPATH=$certpath 
         /vAA_CRWCCERTPASSWD=$certpass 
         /vLAUNCHPROGRAM=1 
         /v""
         /LIweamoruc! log.txt"""

$final_commandline = -join($silent_details,
 $installpath_details,$installation_path,
 $static_installation_path,$custom_details,
 $port_cluster_details,$service_details,
 $db_details,$pg_details,$other)

Write-Host $final_commandline
$a=Get-ChildItem $PSScriptRoot\* -Include *.exe
#$a = "C:\Silent\AutomationAnywhereEnterprise_A2019_<build>.exe"

Write-Host $a
Write-Host "Starting the installation wait for sometime..."

$processdetail=(Start-Process -FilePath 
 $a -ArgumentList $final_commandline 
  -Wait -PassThru).ExitCode

Write-Host $a.Name execution is done. 
If installation is not proper check msi logs in the temp folder.
pause

Прим.:  When using Windows authentication for connecting to Microsoft SQL Server database, ensure
that the following settings are configured:
• The IS_SQLSERVER_AUTHENTICATION installation parameter should be set to 0
• The user assigned to the $service_username parameter should be an active user in Microsoft SQL

Server with permissions set as: db_datareader, db_datawriter, and db_ddladmin
• The $db_user and $db_pwd parameter values should be disabled or commented out

3. Save the script you edit to the server for installation.
4. On the installation server, log on as an administrator, open Powershell in admin mode, and execute the

following: Set-ExecutionPolicy Unrestricted -Scope CurrentUser -Force
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5. Start Powershell in admin mode and execute: .\install.ps1

Прим.:  Журналы автоматической установки хранятся в папке, из которой выполняется
сценарий установки. For example, if you run the script from C:\Silent Install, the logs are
stored in C:\Silent Install folder.

Complete the Control Room configuration and validation.
• After installing the Control Room, complete the configuration settings to ensure timely Automation

Anywhere communications are specified and confirm Automation Anywhere services are running.
• After completing the post-installation tasks, validate the setup by logging in to the Control Room and

installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.

• As a Cloud user with administrator permissions, you can create, view, edit, delete, and enable or disable
a user. Creating users steps vary depending on whether the user is a non-Active Directory, Active
Directory, or single sign-on (SSO) user from an IdP server.

Понятия, связанные с данным
Post-installation user management
After completing the post-installation tasks, validate the setup by logging in to the Control Room and
installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.
Задачи, связанные с данной
Complete Control Room post-installation configuration
After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.
Performing silent installation of Control Room on Linux
Silent Control Room installation, also known as unattended installation, uses a customized script with
parameters specific to your business requirements. The entire installation process runs in the background
without requiring user interaction or displaying messages.
Ссылки, связанные с данной
Пользователи
As an administrator, you can create, view, edit, delete, and enable or disable a user. Creating users steps
vary depending on whether the user is a non-Active Directory, Active Directory, or single sign-on (SSO)
user from an IdP server.

Complete Control Room post-installation configuration
After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.
1. Configure post-installation settings

After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.

2. Verify Automation Anywhere services

Automation Anywhere specific services are installed on the Control Room server.
3. Configure Control Room for HTTPS certificate

Configure Control Room for HTTPS mode using a self-signed or CA certificate either before or after
performing a custom Control Room configuration.
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4. Import HTTPS,and CA certificates

After installing the Control Room, import a certificate for HTTPS, Certificate Authority (CA), or both
using the Windows or Linux command prompt.

5. Configure disaster recovery site for Elasticsearch IP addresses

If you have configured the Control Room for high availability (HA) and disaster recovery (DR) and
installed the Control Room on both the primary and secondary sites, configure Elasticsearch IP
addresses for the secondary site.

6. Add primary IP address for cluster

If your Control Room server has dual IP addresses or network interface cards (NICs) and
you configure the second NIC as your backup IP address, you must manually update the
cluster.properties file to include the backup IP address.

7. Configure additional IP address for a new cluster node

After installing the Control Room in the cluster node, when you add new nodes in the cluster, you
must configure additional static IP addresses for all the nodes in the property file on each node in the
cluster.

Configuring post-installation settings
After you finish installing the Control Room, configure specific items to ensure timely Automation Anywhere
communications.

Post-installation tasks and settings

Exclude anti-virus Exclude anti-virus scans from running in the
Automation Anywhere local repository because they
interfere with running боты.
By default, the repository path is C:
\ProgramData\AutomationAnywhere\Server
 Files. If you have modified the repository path
after installation, you can verify the path from
Administration > Settings > Control Room
database & software.

Set the language locale Select your language as the region setting.
The following example uses English (United States)
as the region setting.
• Windows: Select Control Panel > Region >

Administrative > Change system locale.
For usernames that contain non-ASCII
characters, update the following settings:
1. From Control Panel > Clock and Region

> Administrative > Change system
locale, select the required language from
the Current system locale list.

2. If available, clear the Beta: Use Unicode
UTF-8 for worldwide language support
check box.

3. To change the code page identifier, enter
chcp <identifier-code> at the
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command prompt. For example, enter chcp
 949 to use ANSI or OEM Korean (Unified
Hangul Code).
Code Page Identifiers

4. Restart your machine.

• Linux
1. Verify the current locale:

$ locale

2. Display a list of all available locales on the
server:
$ locale -a

3. Depending on your operating system, use
one of these options to set the locale for the
whole server with the LANG variable.
Substitute language en_US.UTF-8 with
your own:
Ubuntu: sudo update-locale
 LANG=en_US.UTF-8 LANGUAGE

Red Hat Enterprise Linux: sudo
 localectl set-locale
 LANG=en_US.UTF-8

4. Update either the global locale settings
file etc/locale.conf or settings /
~/.bash_profile for the user that owns
Automation 360:
LANG="en_US.utf8"

export LANG

Set the region Select your language as the region format.
Windows: Select Control Panel > Region >
Format.

Set time synchronization Enable Network Time Protocol (NTP) on the Control
Room.
For additional information about setting the NTP,
contact your system administrator.

For Microsoft Azure platform installation, set
configuration

Use the Microsoft Azure Portal to configure:
• Windows credentials
• Control Room settings for repository, URL, and

master key for Credential Vault
• Microsoft Active Directory authentication
• Optionally, SMTP settings
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Задачи, связанные с данной
Complete Control Room post-installation configuration
After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.
Ссылки, связанные с данной
Verifying Automation Anywhere services
Automation Anywhere specific services are installed on the Control Room server.
Working with SQL Servers
Configure Microsoft SQL Servers before setting up the Control Room database.

Verifying Automation Anywhere services
Automation Anywhere specific services are installed on the Control Room server.

Linux users:  См. раздел Stop and start Control Room services on Linux.

Verify installed Windows services

From your Windows device:
1. Select Control Panel > Administrator Tools > Services.

The specific path to Services can vary, depending on your specific Windows version.
2. Scroll through the list to find the listed service name. Note the Status should show as running.

Control Room installed services
Verify that the following Windows services are installed by the Automation Anywhere Control Room
installer.

Имя службы Описание

Automation Anywhere Bot Compiler
Service

Stores all details about the бот compile service. Receives and
processes Бот compilation requests for the Control Room.

Automation Anywhere Control
Room Caching Used for distributed cache storage.

Automation Anywhere Control
Room IQ Bot Service Used for Automation 360 IQ Bot.

Automation Anywhere Control
Room Messaging

Allows Control Room services to communicate
asynchronously.

Automation Anywhere Control
Room Reverse Proxy

Receives all incoming HTTP and HTTPS requests for
Automation Anywhere products and forwards to the correct
service.

Automation Anywhere Control
Room Robotic Interface Service

Is the Automation Anywhere Robotic Interface (AARI) service
used to create and orchestrate workflows between forms and
боты.

Automation Anywhere Control
Room Service Receives and processes API requests for the Control Room.
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Имя службы Описание

Automation Anywhere Elastic
Search Service

Stores all logs and related activities for search functionality.
For details about Elasticsearch, see Elastic Stack and Product
Documentation.

Automation Anywhere Control
Room Discovery Bot Service Used for Discovery Bot.

Automation Anywhere Control
Room Discovery Bot ML Service Used to launch Discovery Bot from Control Room.

Automation Anywhere Control
Room Storage Service Used as a storage solution to leverage automation projects.

• All the services can be configured either in the Local System or Domain account when the Control Room
is installed in Custom mode. For a Control Room installed in Express mode, all the services are run in
the Local System account.

• By default, the Automation Anywhere Control Room services restart automatically after a system
reboot. You do not need a windows service start-up script to restart the services.

• We recommend you wait for two (2) minutes for the Automation Anywhere Control Room services to
restart after a system reboot. If the services do not start automatically, you will see the Bad gateway
error. You can restart the services manually in any sequence.

• Running Рабочая область RPA services is mandatory for using the Рабочая область RPA platform.
However, running the AARI, Discovery Bot, and IQ Bot services is optional for Рабочая область RPA
platform.

Понятия, связанные с данным
Installing Control Room using Custom mode
Log in to the server as an administrator and install Automation Anywhere Control Room in Custom mode to
select installation and configuration options, including installing non-default requirements. Select this mode
for a data center deployment.
Задачи, связанные с данной
Installing Control Room using Express mode
Installing Control Room on Linux
You start installing the Automation Anywhere Control Room in the Linux environment and complete the
installation in the Control Room.

Configure Control Room for HTTPS certificate
Configure Control Room for HTTPS mode using a self-signed or CA certificate either before or after
performing a custom Control Room configuration.

Transportation Layer Security is configured as part of the Control Room installation. If that step was
skipped or the certificate expires, configure the TLS certificate with this post-installation configuration.

Важное замечание:  It is not recommended to use self-signed certificates. However, if you use a self-
signed certificate, ensure you install the certificate on each device manually and accept the certificate
to enable communication between the device and the Control Room after configuring the self-signed
certificate.

1. Войдите в Control Room.
The Control Room instance launches in your default browser.

© 2023 Automation Anywhere. All rights reserved.     974

https://www.elastic.co/guide/index.html
https://www.elastic.co/guide/index.html


    Automation Anywhere - Install and update Automation 360

2. Change the Control Room URL setting and port to HTTPS and port number to 443.
The Website Security Warning page is displayed.

3. Continue to the Control Room website to access the Control Room.

Configure Control Room authentication options

If you have already configured it, then log in to the Control Room.
Задачи, связанные с данной
Import HTTPS,and CA certificates
After you install the Control Room for an On-Premises deployments, you can use the Windows or Linux
command prompt to import all or some of these certificate:
Configure application Transport Layer Security
Use the Transport Layer Security (TLS) configuration wizard page from the Automation 360 installer
to generate a self-signed certificate or import a security certificate to set up a highly secure Control Room
instance.

Import HTTPS,and CA certificates
After you install the Control Room for an On-Premises deployments, you can use the Windows or Linux
command prompt to import all or some of these certificate:
• HTTPS
• Certificate Authority (CA)

You can import HTTPS,and CA certificates in the following scenarios:
• When you switch the Control Room from HTTP to HTTPS after Automation 360 is installed.
• The certificates expire or need modification, for example, when you add a new server.

These instructions apply to both Windows and Linux installations.
To import an HTTPS,or CA certificate to configure the Control Room for secure connection using the
command prompt, perform the following steps:
1. Run the command prompt in administrator mode.
2. Перейдите по пути установки Automation Anywhere.

The default installation path for Windows is C:\Program Files\Automation Anywhere
\Automation360.
The default installation path for Linux is /opt/automationanywhere/enterprise
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3. Enter or paste the following at the command prompt:
• For Windows, if only server certificate is required or if the intermediate certificates are required and

all certificates are in a single file (single file with certificate chain), then enter the command:

jdk11\bin\java -jar certmgr.jar -appDir "C:\Program Files\Automation
 Anywhere\Automation360" -setServerCert "C:\Users\cradmin\Desktop
\test_automationanywhere_com.pfx" -privateKeyPass <PFX Password>

• For Windows CA certificate, enter the command:

jdk11\bin\java -jar certmgr.jar -appDir "C:\Program Files\Automation
 Anywhere\Automation360" -importTrustCert "D:\<user name>\My Downloads
\CA31.cer"

• For Linux CentOS HTTPS certificate, enter the command:

jdk11/bin/java -jar certmgr.jar -appDir "/opt/
automationanywhere/enterprise" -setServerCert "/home/<user>/
test_automationanywhere_com.pfx" -privateKeyPass <PFX Password>

• For Linux CentOS CA certificate, enter the command:

jdk11/bin/java -jar certmgr.jar -appDir 
                        "/opt/automationanywhere/enterprise" 
                        -importTrustCert "CA31.cer"

4. Restart the Control Room Reverse Proxy Service to view the imported certificates.
5. During the installation, if you did not accept the default and indicated you want to upload your own

(self-signed) certificate, add the following parameters to the boot.db.properties file that is
located in the config folder, in the Automation Anywhere installation path.
• Windows file location:

root:\Program Files\Automation Anywhere\config\boot.db.properties
• Linux file location:

/opt/automationanywhere/enterprise/config/boot.db.properties

Parameter:

trustServerCertificate=false

Editing SQL user information
Edit MS-SQL configuration related settings, including username, password, database server name,
database server IP and port numbers.
To perform the task, you must have a  administrator account with the required rights and permissions.
Download the latest Control Room utility and make certain this utility installed on every sever where
Automation 360 is running.

Прим.:

Users are required to make changes to the running configuration via the command line interface.
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Прим.:  Please stop all Automation 360 services on all nodes where a Control Room is installed before
performing this task.

1. Open the command line prompt and navigate to the Automation 360 application.
For example, C:\Program Files\Automation Anywhere\jdk11\bin.

2. Follow the prompts from the utility to select the SQL database and enter the required credentials.

Прим.:  The password will not be displayed on the console

3. Restart the Automation 360 services on the nodes.
The SQL user information has been successfully updated.

Configure disaster recovery site for Elasticsearch IP addresses
If you have configured the Control Room for high availability (HA) and disaster recovery (DR) and installed
the Control Room on both the primary and secondary sites, configure Elasticsearch IP addresses for the
secondary site.
Ensure that you are logged in to the  as the administrator.
Complete the Control Room installation on both the primary and secondary DR sites.
Before adding a new node, ensure the existing cluster is in yellow or green state and all ports on the new
node are open.
Perform this task to make the IP address of the secondary DR site Elasticsearch available to the primary
DR site.
1. From the primary site Control Room, navigate to Administration > Settings > General > Control

Room Database & Software.
2. Click Edit.
3. Enter the DR secondary site Cluster IP address in the Elasticsearch disaster recovery backup

cluster field.
4. Click the plus sign to add additional cluster IP addresses.
5. Click Save Changes.

Понятия, связанные с данным
High availability deployment
To support Automation 360 in your data center, configure an high availability (HA) cluster. Follow your
company methods and procedures for implementing your data center cluster.
Задачи, связанные с данной
Warm stand-by
Host two setups or sites - primary and backup for the warm stand-by DR procedure.

Add primary IP address for cluster
If your Control Room server has multiple IP addresses or network interface cards (NICs), you can manually
update the cluster.properties file to include the primary IP address.
To perform the task, you must have a  administrator account with the required rights and permissions.
• Ensure you have the view and manage settings permission.
• Complete the Control Room installation.
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• Updating the cluster.properties file requires a downtime, so ensure a maintenance window for
the following:
• All the user devices will be disconnected.
• No schedules will run during maintenance.
• Bot Agent and Automation Anywhere Control Room will not be accessible.

Update the cluster.properties file to ensure the caching service requirement to define a single IP
address for the primary NIC of the Control Room.
Ensure that you complete these tasks on all the Control Room nodes in a high availability cluster.
1. Locate the cluster.properties file in your Control Room directory.

For example, the default location is: C:\Program Files\Automation Anywhere\Enterprise
\config\

If the file does not exist in your Control Room directory, create the file.
2. Add the following property option to the cluster.properties file:

ignite.local.static.ip=<nic_ip_address>
For example, ignite.local.static.ip=172.16.20.168

Прим.:  The ignite.local.static.ip property is configured with a single IP address of the
primary NIC of the Control Room with which the communication between the Control Room nodes is
expected. You can manually reconfigure the property when more than one IP address is available.

3. Save the cluster.properties file.
4. Restart the following Automation Anywhere Windows services:

a) Automation Anywhere Control Room Caching
b) Automation Anywhere Control Room Messaging
c) Automation Anywhere Control Room Service

5. To ensure all the cache is in sync, restart the rest of the Automation Anywhere Windows services.

Configure additional IP address for a new cluster node
After installing the Control Room in the cluster node, if you add new nodes in the cluster, you have to
configure additional static IP addresses for all the nodes in the property file on each node in the cluster.
To perform the task, you must have a  administrator account with the required rights and permissions.
• Ensure that you have a maintenance window, which requires complete downtime for the following:

• All the user devices will be disconnected.
• No schedules will run during maintenance.
• Bot Agent and Automation Anywhere Control Room will not be accessible.

• Complete the Control Room installation on any new node.

Perform the following steps on each node in the cluster:
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1. Stop the following Automation Anywhere services on the Control Room node:
a) Automation Anywhere Control Room Reverse Proxy
b) Automation Anywhere Control Room Caching
c) Automation Anywhere Control Room Service
d) Automation Anywhere Elastic Search Service
e) Automation Anywhere Bot Insight Elastic Search
f) Automation Anywhere Control Room IQ Bot Service
g) Automation Anywhere Control Room Robotic Interface Service
h) Automation Anywhere Control Room Discovery Bot Service

2. Locate the cluster.properties file in your Control Room directory.
For example, the default location is: C:\Program Files\Automation Anywhere\Enterprise
\config\

If the file does not exist in your Control Room directory, create the file.
3. Add the following properties and configure the primary IP addresses as a static IP address for all the

cluster nodes (including existing cluster nodes) in the cluster.properties file.

ignite.discovery.mode=static
ignite.discovery.static.ips=<primary ip addresses>

For example: ignite.discovery.static.ips=10.0.11.153,10.0.11.13
4. If the nodes have multiple IP addresses, also add the following property and configure a specific

primary IP address on each node in the cluster:

ignite.local.static.ip=<primary ip address>

For example: ignite.local.static.ip=10.0.11.153
5. Save the cluster.properties file.
6. Modify the elasticsearch.yml file for the new IP address:

a) Locate the elasticsearch.yml file in the Control Room directory.
For example, the default location is: C:\Program Files\Automation Anywhere
\Enterprise\elasticsearch\config\elasticsearch.yml

b) Update elastcissearch.yml with the new IP address using the following property:
discovery.zen.ping.unicast.hosts:["ip1",”ip2”,”ip-new”]

c) Save the elasticsearch.yml file.

7. Start all the services that were stopped in Step 1 on each Control Room node.

Прим.:  Wait for an interval of 40 seconds before starting the next service.

Add Automation 360 On-Premises URLs to trusted list
To ensure secure access to Automation 360 online services for On-Premises deployment, add the URL
specific to the service to the safe recipients or trusted list.
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Automation 360 On-Premises URLs list

Automation 360 online service hosting uses dynamic IP addresses and therefore we recommend that you
add to the safe recipients or trusted list the complete URL instead of an IP address for the Automation
Anywhere online services.

Прим.:  The list can vary based on the end-user environment for On-Premises deployments.

Служба URL-адрес Порт Устройства

Automation Anywhere www.automationanywhere.comTCP 443 (HTTPS) All devices

Automation Anywhere
community (A-People)

apeople.automationanywhere.comTCP 443 (HTTPS) All devices

Automation Anywhere
documentation

docs.automationanywhere.comTCP 443 (HTTPS) All devices

Automation Anywhere Cloud
license server

license.automationanywhere.digitalTCP 443 (HTTPS) All devices that
run Automation
360 Control Room

Bot Store botstore.automationanywhere.comTCP 443 (HTTPS) All devices

Telemetry
Allows performance and
usage information to be
gathered anonymously in
order to improve product
quality.

• cdn.pendo.io
• app.pendo.io/
• data.pendo.io/
• https://pendo-

static-5673999629942784.storage.googleapis.com/

TCP 443 (HTTPS) All devices

Automation Anywhere
Google Chrome extension
Enables you to automate
using the Google Chrome
browser.

https://
chrome.google.com/
webstore/detail/
automation-360/
kammdlphdfejlopponbapgpbgakimokm

TCP 443 (HTTPS) Bot Creator
and Bot Runner
devices

Automation Anywhere
Microsoft Edge extension
Enables you to automate
using the Microsoft Edge
browser.

https://
microsoftedge.microsoft.com/
addons/detail/
automation-360/
dbmodiepejcigljbmeebedkmegndokbk

TCP 443 (HTTPS) Bot Creator
and Bot Runner
devices

Automation Anywhere
Mozilla Firefox extension
Enables you to automate
using Mozilla Firefox
browser.

https://
addons.mozilla.org/
en-US/firefox/addon/
automation-360

TCP 443 (HTTPS) Bot Creator
and Bot Runner
devices
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Файлы и папки

For information on files and folders to add to the safe list and to the antivirus exception list, see these
articles:
• Files and URLs to add to safe list for Automation 360 (A-People login required)
• List of files to add to antivirus exception list for Automation 360 (A-People login required)

Ссылки, связанные с данной
Add Automation 360 Cloud URLs to trusted list
To ensure secure access to Automation 360 cloud services, add the URL specific to the service to the safe
recipients or trusted list.

Uninstalling Automation 360
Use the Automation 360 installer or the Uninstall or change a program option from the Windows
Control Panel to remove or uninstall a Control Room instance.
1. To uninstall the Control Room using the installer, run the setup file from the installation path.

Run the installer in admin mode.
2. In the InstallShield wizard, click Next.
3. Click Remove.
4. Click Finish to complete uninstalling the Control Room from your machine or server.

Понятия, связанные с данным
Миграция в Automation 360
Ссылки, связанные с данной
Installing Control Room On-Premises
Review the installation core tasks and topics for installing the Automation 360 Control Room in a data
center on an On-Premises server or a cloud service provider server instance.

Installing Control Room for Cloud-enabled deployment
With Cloud-enabled deployment, you can store and process native business and operational data on site
and take advantage of management and operational services delivered from Automation Anywhere Cloud.
Automation Anywhere deploys and provisions an Automation 360 Cloud-enabled service instance in our
cloud to deliver management and operational capabilities. Customer then installs the Cloud-enabled
application within their infrastructure to consume these capabilities for storing and processing customer
data.

Прим.:  Linux is not supported for Cloud-enabled deployments.

For Cloud-enabled deployment, the initial welcome email that you received from Automation Anywhere
contains:
• URL to the Automation Anywhere Cloud-enabled instance
• Provisioning token needed to establish trust connectivity with the Automation Anywhere Cloud Control

Room
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Важное замечание:  Do not discard the content of this email. You will need the information in the email
to setup on-premises application.

1. Receive your Automation 360 Cloud-enabled service URL from Automation Anywhere and provisioning
token.

2. Install and access the On-Premises application.
Download and install the Cloud-enabled application on your network; the installation user is assigned
administrator privileges.
Installing Control Room On-Premises

3. Log in to the On-Premises Control Room.
Вход в Automation Anywhere Control Room

4. Navigate to Administration > Settings > Cloud-Enabled.
5. Provide the provisioning token to connect to the Control Room.
6. Щелкните Сохранить изменения.

The trusted relationship between the instances is created.
7. To test Cloud-Enabled functionality, open a browser, enter the URL of the Cloud Control Room service

instance, and press Enter.
You are redirected to the On-Premises Control Room.

Понятия, связанные с данным
Post-installation user management
After completing the post-installation tasks, validate the setup by logging in to the Control Room and
installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.
Задачи, связанные с данной
Установка Bot Agent и регистрация устройств
Install Bot Agent on your local device and connect it to Control Room. In order to run боты on that local
device, ensure that you add it to the list of enabled host devices.
Ссылки, связанные с данной
Installed Control Room directories and files
When installing the Automation Anywhere Control Room on different operating systems, the installer
executes and installs files and folders in the following directories.

Naming guidelines for Control Room URLs
Adhere to Domain Name System (DNS) guidelines when you configure domain and subdomain Control
Room URLs for On-Premises and Cloud deployments.
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Guidelines for On-Premises Control Room deployments

By following these DNS guidelines, you can successfully register your Bot Agent with the On-Premises
Control Room. According to RFC 952, RFC 1035, and RFC 1123, the following guidelines apply when
creating names for domain and subdomain URLs:
• The host name can be up to 63 characters in length and can contain the following characters:

• Uppercase characters (A–Z)
• Lowercase characters (a–z)
• Numerals (0–9)
• Hyphens (-)

• The host name should not consist of all numeric values.
• The host name should not start nor end with a hyphen (-).
• The URL domain and subdomain names should not contain the underscore character (_).

Прим.:  Instead of an underscore (_), use a hyphen (-).

Guidelines for Cloud Control Room deployments

By following DNS guidelines, you can successfully register your Bot Agent with
the Cloud Control Room. The Cloud Control Room URL syntax is: https://
<domainname>.myautomationanywhere.digital, where <domainname> is configurable.
• The domain name can be up to 27 characters in length and can contain the following characters:

• Lowercase characters (a–z)
• Numerals (0–9)
• Hyphens (-)

• The domain name should not consist of all numeric values.
• The domain name should not start nor end with a hyphen (-).
• The URL domain and subdomain names should not contain the underscore character (_).

Прим.:  Instead of an underscore (_), use a hyphen (-).

Ссылки, связанные с данной
Automation 360 Cloud prerequisites
Use the checklist to determine whether your device fulfills the requirements for registering with
Automation 360 Cloud.
Automation 360 On-Premises prerequisites
Determine whether the system has the required hardware and software to install Control Room for
Automation 360 On-Premises.
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Post-installation user management
After completing the post-installation tasks, validate the setup by logging in to the Control Room and
installing a license. First time access to the Control Room walks you through the configuration for your
authentication method.

Configure Control Room authentication options The options for launching the Control Room for the
first time and the authentication method depend on
the installation mode and deployment type.

Validate services Validate that the following services are running in
automatic mode:
• Automation Anywhere Control Room Caching
• Automation Anywhere Control Room Messaging
• Automation Anywhere Control Room Reverse

Proxy
• Automation Anywhere Control Room Service
• Automation Anywhere Elastic Search Service
• Automation Anywhere Bot Compiler Service
• Automation Anywhere Control Room IQ Bot

Service
• Automation Anywhere Control Room Robotic

Interface Service
• Automation Anywhere Control Room Discovery

Bot Service
• Automation Anywhere Control Room Discovery

Bot ML Service
• Automation Anywhere Control Room Storage

Service

Пользователи As an administrator, you can create, view, edit,
delete, and enable or disable a user. Creating users
steps vary depending on whether the user is a non-
Active Directory, Active Directory, or single sign-on
(SSO) user from an IdP server.

Задачи, связанные с данной
Complete Control Room post-installation configuration
After installing the Control Room, complete the configuration settings to ensure timely Automation
Anywhere communications are specified and confirm Automation Anywhere services are running.

Configure the Control Room as a service provider
A valid SAML IDP setup must be configured before the Control Room can be switched to a SAML-
authentication environment.
This task is performed by a network administrator. You must have the necessary privileges to complete this
configuration.
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Complete the necessary network-side preparations to switch the Control Room to act as the service
provider in the SAML IDP setup.
1. Set the ACS or service provider URL to <Enterprise Control Room URL>/v1/

authentication/saml/assertion.

Прим.:  Ensure that you do not configure the SAML assertions for single logout.

2. Create user with matching information in the Control Room.
Key attributes include: UserID, FirstName, LastName, and EmailAddress.
This value will be required when setting up the Control Room side of this configuration.

3.
4. Update SAML settings for Active Directory.

Make the necessary updates to pertinent directories and toolkits, making certain to select Single Sign
On as the login method.

<saml2:AuthnStatement
 AuthnInstant="authenticated_instance" SessionIndex="index_value_required">

Set up SAML authentication on the Control Room

Задачи, связанные с данной
Настройка аутентификации SAML
Switch an authenticated environment Control Room database to a SAML identity provider (IdP).

Configure Control Room authentication options
The options for launching the Control Room for the first time and the authentication method depend on
the installation mode and deployment type.
The authentication options for Control Room in Cloud and Cloud-enabled deployments differ from the
options for On-Premises deployment (installed using the Custom mode).
After the installation (Custom mode) is complete, configure the Control Room in Custom mode to
authenticate users with an Active Directory (AD), Control Room database, or single sign-on (SSO).

Прим.:  The Active Directory authentication mode is available for On-Premises deployment and not for
Cloud and Cloud-enabled deployments.

Based on your installation mode (express or custom) and deployment type (On-Premises, Cloud, and
Cloud-enabled), select any of the following authentication methods for the Control Room:
• After an Express mode installation, configure the Control Room in Express mode using the default

settings.
Configure Control Room in Express mode

• Authenticate users using Active Directory by manually adding the LDAP URLs.
Configure Control Room for Active Directory: manual mode

• Authenticate users using Active Directory by enabling the Control Room to discover and list domains
and sites in your organization.
Configure Control Room for Active Directory: auto mode
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• Authenticate users using the database option.

Настройка базы данных Control Room
• Configure an authenticated environment Control Room database to a SAML identity provider (IDP).

Настройка аутентификации SAML
• Configure the environment for Smart Card, X.509 Certificate authentication.

Configure Smart Card authentication installation procedure

Configure Control Room in Express mode
After completing the installation in Express Mode, configure the Control Room in Express Mode using the
default settings.
To configure Control Room when you start it for the first time, do the following steps:
1. Open Control Room in a browser to launch the Getting Started wizard.

• Windows: Double-click the Automation Anywhere Control Room icon on the desktop.
• Linux: Open a browser and navigate to the Linux server hostname. Example:

server1.mycompany.com

2. Заполните следующие поля.
• Имя пользователя. Введите имя пользователя.
• Имя. Введите имя.
• Фамилия. Введите фамилию.
• Эл. почта. Введите адрес электронной почты.
• Пароль. Введите пароль.
• Подтвердить пароль. Подтвердите пароль.

3. Щелкните Вперед.
Откроется страница Создать контрольные вопросы.

4. Введите три контрольных вопроса и ответы на них.
5. Щелкните Вперед.

The Credential settings page appears.
6. Выберите один из указанных ниже параметров.

• Express mode:The system stores your master key to connect to the Credential Vault on the
Control Room filesystem. Этот режим не рекомендуется для рабочей среды.

• Ручной режим. Вы самостоятельно сохраняете Master Key, а затем вводите Master Key,
когда Credential Vault заблокировано. Пользователи используют Master Key для подключения
к Credential Vault с целью защиты учетных данных и получения доступа к ним при создании и
запуске TaskBots.

Важное замечание:  Если вы потеряете ключ, то не сможете получить доступ к Control
Room.

7. Щелкните Сохранить и войти.
Вы вошли в систему Control Room как администратор. Теперь можно настроить общую среду RPA
и начать управлять ею с помощью Control Room и клиентов.

After configuring the Control Room, install product licenses.

© 2023 Automation Anywhere. All rights reserved.     986



    Automation Anywhere - Install and update Automation 360

Configure Control Room for Active Directory: manual mode
Configure the Control Room to authenticate users using Active Directory by manually adding the
Lightweight Directory Access Protocol (LDAP) URLs.
To configure the Control Room when you start it for the first time, do the following:
1. Double-click the Automation Anywhere Control Room icon on your desktop.

Откроется страница Настроить параметры Control Room.
2. Type the repository path.

This is the location where the uploaded automation files, for example, IQ Bots, and TaskBots are
stored. For example, C:\ProgramData\AutomationAnywhere\Server Files.

3. Введите URL-адрес для доступа.
Это URL-адрес для доступа к установке Control Room.

4. Щелкните Сохранить и продолжить.

Важное замечание:  Кнопка Назад в веб-браузере автоматически отключается после щелчка
по Сохранить и продолжить. Это гарантирует, что генерируемый Master Key Credential Vault
соответствует пути к репозиторию и URL-адресу доступа к Control Room.
Чтобы вернуться на страницу Настроить параметры Control Room, нажмите Ctrl + F5 и
выполните перезагрузку.

Откроется страница Настройки Credential Vault.
5. Выберите один из указанных ниже параметров.

• Экспресс-режим. Система сохраняет мастер-ключ для подключения к Credential Vault. Этот
режим не рекомендуется для рабочей среды.

• Ручной режим. Вы самостоятельно сохраняете Master Key, а затем вводите Master Key,
когда Credential Vault заблокировано. Пользователи используют Master Key для подключения
к Credential Vault с целью защиты учетных данных и получения доступа к ним при создании и
запуске TaskBots.

Важное замечание:  Если вы потеряете ключ, то не сможете получить доступ к Control
Room.

6. Щелкните Сохранить и продолжить.

Важное замечание:  Кнопка Назад в веб-браузере автоматически отключается после щелчка
по Сохранить и продолжить. Дальнейшие изменения конфигурации Control Room или
настроек Credential Vault не допускаются.
Чтобы внести изменения, переустановите Control Room.

Откроется страница Тип аутентификации для пользователей Control Room.
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7. Select Active Directory.
Automation Anywhere supports Active Directory Multi-Forest authentication for the Control Room.
Before providing the Authentication Type, ensure the following:
• One-way or two-way trust is set up between all forests. For a one-way trust, this is from the

Enterprise Client forest to the Control Room forest (Control Room forest must always be the
trusting forest).

• Two-way trust is set up for every domain in a forest.
• The root certificate of the LDAP server is imported using the provided CertMgr tool via command.
• The provided LDAP URLs per forest cannot be behind a load balancer. Also, all LDAP URLs must

point to the root (main) domain controllers.
• The node that runs the Control Room is in the same domain network where the Active Directory

runs.
• The user is in the parent domain and the URL points to the parent.

This ensures that when there are two or more forests, and one of the forest has a subdomain with
a different name space, a user from the other forests does not have permission to access that
subdomain.

8. Type the Global Catalog URL.
Например, ldap://server01.domain.com, .
For failsafe authentication, click the plus option to provide additional LDAP URLs.

Прим.:  For users and groups from one or more Active Directory domains, to access the Control
Room, use a fully qualified host name of the Global Catalog (GC) server, listening on port 3268 (3269
if SSL).

When adding LDAP URLs, ensure that you provide a fully qualified host name like ldap://
server01.ldap.com.
Provide URLs of multiple Global Catalogs per forest so that if one Global Catalog in a forest goes
down, the other can serve. This feature does not provide support for the load-balanced URL.
You must enter the Domain username and password and click Manually add connections to enter
the LDAP URLs.

9. Provide service account credentials
Ensure that the username provided is a user in the Domain Users group and ideally and be set up in
Active Directory with a password never expires option. If otherwise, there will be some downtime
in RPA authentication as the service account password is reset. Provide the username in a User
Principal Name (UPN) in the username@domain.com format and password.

10. Click Check connection.
If Control Room is unable to connect to the Active Directory database, an error message appears.

11. Щелкните Вперед.
Откроется страница Первый администратор Control Room.

12. Select the Active Directory domain from the drop-down list and type the Control Room
administrator username.

13. Click Check name in Active Directory.
If the username is in the Active Directory the following user details are shown:
• First name
• Last name
• Email

You can edit these prepopulated fields.
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14. Щелкните Сохранить и войти.
Вы вошли в систему Control Room как администратор. Теперь можно настроить общую среду RPA
и начать управлять ею с помощью Control Room и клиентов.

After configuring the Control Room, install product licenses.
Задачи, связанные с данной
Configure Control Room for Active Directory: auto mode
Configure the Control Room to authenticate users using Active Directory by enabling the Control Room to
discover and list domains and sites in your organization.

Configure LDAP channel binding
Configure LDAP channel binding in Automation 360 On-Premises for enhanced security in network
communications between an Active Directory and its clients. This method provides a more secure LDAP
authentication over SSL and TLS.
Enable channel binding in the um.properties file when required.
1. Go to the Control Room installation path.
2. From the list of files in the config folder, open the um.properties file with an XML editor.
3. Add the um.ldap.channel.binding.enabled property in the um.properties file.

For example, um.ldap.channel.binding.enabled=false
4. To enable channel binding, change the value to true.

The default value is false and channel binding is disabled.
Channel binding is enabled if it is enabled on the server side.
For information about enabling channel binding on the server side, see LDAP enforce channel binding
registry entry.

5. Сохраните файл.

Configure Control Room for Active Directory: auto mode
Configure the Control Room to authenticate users using Active Directory by enabling the Control Room to
discover and list domains and sites in your organization.
To configure the Control Room when you start it for the first time, do the following:
1. Double-click the Automation Anywhere Control Room icon on your desktop.

Откроется страница Настроить параметры Control Room.
2. Type the repository path.

This is the location where the uploaded automation files, for example, IQ Bots, and TaskBots are
stored. For example, C:\ProgramData\AutomationAnywhere\Server Files.

3. Введите URL-адрес для доступа.
Это URL-адрес для доступа к установке Control Room.
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4. Щелкните Сохранить и продолжить.

Важное замечание:  Кнопка Назад в веб-браузере автоматически отключается после щелчка
по Сохранить и продолжить. Это гарантирует, что генерируемый Master Key Credential Vault
соответствует пути к репозиторию и URL-адресу доступа к Control Room.
Чтобы вернуться на страницу Настроить параметры Control Room, нажмите Ctrl + F5 и
выполните перезагрузку.

Откроется страница Настройки Credential Vault.
5. Выберите один из указанных ниже параметров.

• Экспресс-режим. Система сохраняет мастер-ключ для подключения к Credential Vault. Этот
режим не рекомендуется для рабочей среды.

• Ручной режим. Вы самостоятельно сохраняете Master Key, а затем вводите Master Key,
когда Credential Vault заблокировано. Пользователи используют Master Key для подключения
к Credential Vault с целью защиты учетных данных и получения доступа к ним при создании и
запуске TaskBots.

Важное замечание:  Если вы потеряете ключ, то не сможете получить доступ к Control
Room.

6. Щелкните Сохранить и продолжить.

Важное замечание:  Кнопка Назад в веб-браузере автоматически отключается после щелчка
по Сохранить и продолжить. Дальнейшие изменения конфигурации Control Room или
настроек Credential Vault не допускаются.
Чтобы внести изменения, переустановите Control Room.

Откроется страница Тип аутентификации для пользователей Control Room.
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7. Select Active Directory.
Automation Anywhere supports Active Directory multi-forest authentication for the Control Room.
Before providing the authentication type, ensure the following:
• For one-way trust between forests:

• The Bot Agent devices are in one or more forests and the Control Room is in a different forest,
theControl Room must be in the trusting forest.

• Set up trust between the forest that contains the Control Room and each of the forests
containing the Bot Agent devices.

• Domains containing Bot Agent devices and the Control Room must be configured with two-way
trust between the domains.

• For two-way trust between forests:
• In the scenario where the Bot Agent devices are in one or more forests and the Control Room

is in a different forest, all forests containing Bot Agent device and the Control Room are
configured with two-way trust between forests.

• Set up trust between all forests containing the Control Room and the Bot Agent devices.
• Domains containing Bot Agent devices and the Control Room must be configured with two-way

trust between the domains.

• The root certificate of the LDAP server is imported using the provided CertMgr tool via command.
• The provided LDAP URLs per forest cannot be behind a load balancer. Also, all LDAP URLs must

point to the root (main) domain controllers.
• The node that runs the Control Room is in the same domain network where the Active Directory

runs.
• The user is in the parent domain and the URL points to the parent.

This ensures that when there are two or more forests, and one of the forest has a sub-domain with
a different name space, a user from the other forests does not have permission to access that sub-
domain.

8. Type the Domain username.
Ensure you use the User Principal Name (UPN) in the username@domain.com format.
The username you enter is for a user who has access to all domains using the same credentials.

9. Type the Domain password.
This user is not expected to use the Control Room. Although you have an option to update the
password, use an Account with the password never expires option. If it expires, it can be updated but
with some downtime.

10. Click Discover connections.
All discovered Active Directory domains with one or more sites per domain are shown.
By default, all domains and sites are selected. If only one domain and one site under it is discovered,
then it is shown in read-only mode and cannot be edited.
You can configure the maximum number of sites per domain that can be discovered across multiple
domains by adding the following property in the um.properties file saved in <installation
 path>/config:
um.ldap.auto.discovery.find.max.sites=<number of sites>

For example, you can configure auto-discovery for a maximum of 15 sites per domain by adding the
entry um.ldap.auto.discovery.find.max.sites=15 in the um.properties file. This means
that for every domain that you have, a maximum of 15 associated sites can be discovered per domain.

Прим.:  If this property is not configured, by default, 10 sites per domain will be discovered.
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11. Select the domains and sites to use for authentication.
Select the domains and sites to use for authentication. Select a minimum of one site for each domain
that is selected

12. Click Test connections to register the sites to use for authentication.
13. Click Check connection.

If Control Room is unable to connect to the Active Directory database, an error message appears.
14. Щелкните Вперед.

Откроется страница Первый администратор Control Room.
15. Select the Active Directory domain from the drop-down list and type the Control Room

administrator username.
16. Click Check name in Active Directory.

If the username is in the Active Directory the following user details are shown:
• First name
• Last name
• Email

You can edit these pre-populated fields.
17. Щелкните Сохранить и войти.

Вы вошли в систему Control Room как администратор. You can now configure and manage the
overall RPA environment with Control Room and Bot Agent.

After configuring the Control Room, install product licenses.
Задачи, связанные с данной
Configure Control Room for Active Directory: manual mode
Configure the Control Room to authenticate users using Active Directory by manually adding the
Lightweight Directory Access Protocol (LDAP) URLs.
Настройка базы данных Control Room
Настройте Control Room для аутентификации пользователей с помощью параметра базы данных.

Configure Smart Card authentication installation procedure
Configure the Control Room to authenticate users using the Smart Card option.
To perform the task, you must have a  administrator account with the required rights and permissions.
Follow these steps to configure your Cloud Control Room to use Smart Card, X.509 certificate
authentication.
1. Configure the secondary hostname to point to the Control Room load balancer.

This process defines the secondary hostname used for authentication requests when the Control Room
is configured for Smart Card authentication. The secondary hostname is configured within the Control
Room load balancer automatically. Both the primary and secondary hostnames must be configured
within the DNS system used by the Control Room environment (add DNS entries for primary and
secondary hostnames - external to Control Room).
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2. How to obtain Java KeyStore with trusted CA certificates.
Configure the location the Control Room will check for Certificate Authority (CA) certificates used to
authenticate user certificates for user logins.

Прим.:  The certificates in this location are the server certificates for the CAs that will issue the user
certificates.

Вариант Действие

Периодически сканируйте следующее
местоположение

This setting allows the administrator to define
the path to keystore file containing the CA
certificates. Use this setting if you periodically
update the CA truststore and set the frequency of
the scan.

Загрузить хранилище ключей вручную This setting allows the administrator to load a
keystore file containing the CA certificates. Use
this setting if your CAs are known and static and
indicate whether or not the keystore is password
protected. If the keystore is password protected,
supply and confirm the password.

3. Select the revocation checking method.
Revocation checking configures the Control Room to reject authentication requests for certificates that
have been revoked.
Вариант Действие

Online Certificate Status Protocol (OSCP) Use this setting if your CA has OSCP
implemented.

Список отзывов сертификатов Use this setting if you maintain a static list of
revoked certificates.

Нет проверки отзывов Using this setting the Control Room will not
perform revocation check.

Прим.:  This is not recommended for production
deployments where revocation will typically be
used.

4. Use the other method if selected method fails
This setting will attempt to use the non-selected method of revocation checking if the configured
method fails.

5. Allow user to authenticate even if revocation status cannot be determined
Use this setting to assure users can authenticate if either of the revocation check method fails.

6. Configure user name mapping.
User name mapping specifies which attribute of the user certificate is used for the Control Room
username. The user name must be configured in the Control Room prior to the user logging into the
Control Room and must match the user name derived from the certificate.
a) Obtain user name from

Тема сертификата Use this setting if the Control Room user name
is the same as the string in the Subject field for
the user certificate.
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Имя универсального участника Use this setting if the Control Room user name
is the same as the string in the Universal
Principal Name field for the user certificate.

b) Use Regular Expression
Enter Regular Expression that will filter the Control Room user name from the selected field of the
user certificate. This may not be necessary if the Control Room user name is the same as the data
within the selected certificate field.

7. Configure first name mapping.
First name mapping specifies which attribute of the user certificate is used for the Control Room
username. The first name must be configured in the Control Room prior to the user logging into the
Control Room and must match the user first name derived from the certificate.
a) Obtain first name from

Тема сертификата Use this setting if the Control Room first name
is the same as the string in the Subject field for
the user certificate.

Имя универсального участника Use this setting if the Control Room user name
is the same as the string in the Universal
Principal Name field for the user certificate.

b) Use Regular Expression
Enter Regular Expression that will filter the Control Room user first name from the selected field
of the user certificate. This may not be necessary if the Control Room user first name is the same
as the data within the selected certificate field.

8. Configure last name mapping.
Last name mapping specifies which attribute of the user certificate is used for the Control Room
username. The last name must be configured in the Control Room prior to the user logging into the
Control Room and must match the user last name derived from the certificate.
a) Obtain last name from

Тема сертификата Use this setting if the Control Room last name
is the same as the string in the Subject field for
the user certificate.

Имя универсального участника Use this setting if the Control Room user name
is the same as the string in the Universal
Principal Name field for the user certificate.

b) Use Regular Expression
Enter Regular Expression that will filter the Control Room user last name from the selected field of
the user certificate. This may not be necessary if the Control Room user last name is the same as
the data within the selected certificate field.

9. Configure email address mapping.
Email address mapping specifies which attribute of the user certificate is used for the Control Room
username. The email address must be configured in the Control Room prior to the user logging into
the Control Room and must match the user last name derived from the certificate.
a) Obtain last name from

Тема сертификата Use this setting if the Control Room email
address is the same as the string in the Subject
field for the user certificate.
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Имя универсального участника Use this setting if the Control Room user name
is the same as the string in the Universal
Principal Name field for the user certificate.

b) Use Regular Expression
Enter Regular Expression that will filter the Control Room user email address from the selected
field of the user certificate. This may not be necessary if the Control Room user email address is
the same as the data within the selected certificate field.

10. Щелкните Вперед.

Control Room smart card first administrator
After configuring the smart card authentication process, an administrator user is needed. This process will
walk you through setting up the first administrator for the Control Room.
To perform the task, you must have a  administrator account with the required rights and permissions.
When authenticating with smart cards, the authenticating system will send a signal to the operating
system to "Insert Smart Card" and prompt the user, from the smart card software, to select the certificate
to use for authentication.
The following steps guide you through setting up your first administrator user with smart card
authentication installed.
You should be on the correct configuration page if you have completed Configure Smart Card authentication
installation procedure.
1. Navigate to  > Control Room first administrator.
2. Insert the smart card for the administrator.
3. Click Authenticate and pre-fill user data.

This will start the smart card authentication process and pre-fill data from the selected certificate
base on the mappings defined during the configuration of the Certificate (smart card) authentication
installation process. If any information requires correction, click the Back button and make the
necessary changes.

4. Verify the data.
View the Username, First Name, Last Name, and Email Address that is pre-filled and verify that these
data points were correctly mapped during the smart card authentication installation procedure.

5. Click Save and log in
The configuration of Certificate (smart card) authentication strategy is complete.

After configuration of the smart card authentication process, the login page of the Control Room will
display only the "Insert CAC/PIV" option for authenticating the user. Pressing this button will start the
smart card authentication process and the browser will signal a smart card login request to the operating
system which will then prompt the user to insert their smart card and possibly an optional PIN.
The user selects the appropriate certificate on the smart card and proceeds with the Control Room login.

Настройка базы данных Control Room
Настройте Control Room для аутентификации пользователей с помощью параметра базы данных.
To configure the Control Room when you start it for the first time, do the following:
1. Откройте браузер и перейдите по URL-адресу Control Room.

Откроется страница Настроить параметры Control Room.
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• Windows
Дважды щелкните по значку Automation Anywhere Control Room на рабочем столе.

• Linux
Откройте браузер и перейдите к имени хоста сервера, на котором установлена Automation
Anywhere Control Room. Пример: myserver.mycompany.com

Прим.:  Не оставляйте в конце URL косую черту, так как произойдет сбой валидации.

2. Введите путь к репозиторию.
• Windows

В этой папке будут храниться загруженные файлы автоматизации, например IQ Bot, а также
TaskBots. Например:
C:\ProgramData\AutomationAnywhere\Server Files

• Linux
/opt/automationanywhere/enterprise/appdata

3. Введите URL-адрес для доступа.
Это URL-адрес для доступа к установке Control Room.

4. Щелкните Сохранить и продолжить.

Важное замечание:  Кнопка Назад в веб-браузере автоматически отключается после щелчка
по Сохранить и продолжить. Это гарантирует, что генерируемый Master Key Credential Vault
соответствует пути к репозиторию и URL-адресу доступа к Control Room.
Чтобы вернуться на страницу Настроить параметры Control Room, нажмите Ctrl + F5 и
выполните перезагрузку.

Откроется страница Настройки Credential Vault.
5. Выберите один из указанных ниже параметров.

• Экспресс-режим. Система сохраняет мастер-ключ для подключения к Credential Vault. Этот
режим не рекомендуется для рабочей среды.

• Ручной режим. Вы самостоятельно сохраняете Master Key, а затем вводите Master Key,
когда Credential Vault заблокировано. Пользователи используют Master Key для подключения
к Credential Vault с целью защиты учетных данных и получения доступа к ним при создании и
запуске TaskBots.

Важное замечание:  Если вы потеряете ключ, то не сможете получить доступ к Control
Room.

6. Щелкните Сохранить и продолжить.

Важное замечание:  Кнопка Назад в веб-браузере автоматически отключается после щелчка
по Сохранить и продолжить. Дальнейшие изменения конфигурации Control Room или
настроек Credential Vault не допускаются.
Чтобы внести изменения, переустановите Control Room.

Откроется страница Тип аутентификации для пользователей Control Room.
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7. Выберите База данных Control Room.
Выберите Active Directory, единый вход (SAML 2), сертификат (смарт-карта) или база данных
Control Room. Обратитесь к соответствующим разделам конфигурации, чтобы узнать больше об
этапах и процессах.

8. Щелкните Вперед.
Откроется страница Первый администратор Control Room.

9. Заполните следующие поля.
• Имя пользователя. Введите имя пользователя.
• Имя. Введите имя.
• Фамилия. Введите фамилию.
• Эл. почта. Введите адрес электронной почты.
• Пароль. Введите пароль.
• Подтвердить пароль. Подтвердите пароль.

10. Щелкните Вперед.
Откроется страница Создать контрольные вопросы.

11. Введите три контрольных вопроса и ответы на них.
12. Щелкните Сохранить и войти.

Вы вошли в систему Control Room как администратор. Теперь можно настроить общую среду RPA
и начать управлять ею с помощью Control Room и клиентов.

Установите лицензию.
Задачи, связанные с данной
Configure Control Room for Active Directory: manual mode
Configure the Control Room to authenticate users using Active Directory by manually adding the
Lightweight Directory Access Protocol (LDAP) URLs.
Configure Control Room for Active Directory: auto mode
Configure the Control Room to authenticate users using Active Directory by enabling the Control Room to
discover and list domains and sites in your organization.

Configure Control Room for HTTPS certificate
Configure Control Room for HTTPS mode using a self-signed or CA certificate either before or after
performing a custom Control Room configuration.

Transportation Layer Security is configured as part of the Control Room installation. If that step was
skipped or the certificate expires, configure the TLS certificate with this post-installation configuration.

Важное замечание:  It is not recommended to use self-signed certificates. However, if you use a self-
signed certificate, ensure you install the certificate on each device manually and accept the certificate
to enable communication between the device and the Control Room after configuring the self-signed
certificate.

1. Войдите в Control Room.
The Control Room instance launches in your default browser.

2. Change the Control Room URL setting and port to HTTPS and port number to 443.
The Website Security Warning page is displayed.

3. Continue to the Control Room website to access the Control Room.

Configure Control Room authentication options
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If you have already configured it, then log in to the Control Room.
Задачи, связанные с данной
Import HTTPS,and CA certificates
After you install the Control Room for an On-Premises deployments, you can use the Windows or Linux
command prompt to import all or some of these certificate:
Configure application Transport Layer Security
Use the Transport Layer Security (TLS) configuration wizard page from the Automation 360 installer
to generate a self-signed certificate or import a security certificate to set up a highly secure Control Room
instance.

Import HTTPS,and CA certificates
After you install the Control Room for an On-Premises deployments, you can use the Windows or Linux
command prompt to import all or some of these certificate:
• HTTPS
• Certificate Authority (CA)

You can import HTTPS,and CA certificates in the following scenarios:
• When you switch the Control Room from HTTP to HTTPS after Automation 360 is installed.
• The certificates expire or need modification, for example, when you add a new server.

These instructions apply to both Windows and Linux installations.
To import an HTTPS,or CA certificate to configure the Control Room for secure connection using the
command prompt, perform the following steps:
1. Run the command prompt in administrator mode.
2. Перейдите по пути установки Automation Anywhere.

The default installation path for Windows is C:\Program Files\Automation Anywhere
\Automation360.
The default installation path for Linux is /opt/automationanywhere/enterprise

3. Enter or paste the following at the command prompt:
• For Windows, if only server certificate is required or if the intermediate certificates are required and

all certificates are in a single file (single file with certificate chain), then enter the command:

jdk11\bin\java -jar certmgr.jar -appDir "C:\Program Files\Automation
 Anywhere\Automation360" -setServerCert "C:\Users\cradmin\Desktop
\test_automationanywhere_com.pfx" -privateKeyPass <PFX Password>

• For Windows CA certificate, enter the command:

jdk11\bin\java -jar certmgr.jar -appDir "C:\Program Files\Automation
 Anywhere\Automation360" -importTrustCert "D:\<user name>\My Downloads
\CA31.cer"

• For Linux CentOS HTTPS certificate, enter the command:

jdk11/bin/java -jar certmgr.jar -appDir "/opt/
automationanywhere/enterprise" -setServerCert "/home/<user>/
test_automationanywhere_com.pfx" -privateKeyPass <PFX Password>

• For Linux CentOS CA certificate, enter the command:

jdk11/bin/java -jar certmgr.jar -appDir 
                        "/opt/automationanywhere/enterprise" 
                        -importTrustCert "CA31.cer"
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4. Restart the Control Room Reverse Proxy Service to view the imported certificates.
5. During the installation, if you did not accept the default and indicated you want to upload your own

(self-signed) certificate, add the following parameters to the boot.db.properties file that is
located in the config folder, in the Automation Anywhere installation path.
• Windows file location:

root:\Program Files\Automation Anywhere\config\boot.db.properties
• Linux file location:

/opt/automationanywhere/enterprise/config/boot.db.properties

Parameter:

trustServerCertificate=false

Add Control Room certificate to Windows certificate stores
To ensure that the Bot Agent is registered successfully and works as intended, manually add or update
the Control Room certificate to the Windows certificate stores. Perform this task if the Windows certificate
stores does not accept the certificate and you see a certificate path validation error.
You must reinstall the certificates in the Windows certificate stores if the Bot Agent is updated.
Чтобы разрешить сертификат в браузере на компьютере Bot Agent, загрузите и установите
сертификат.
1. Чтобы загрузить сертификат с помощью Google Chrome, выполните указанные ниже действия.

a) Откройте экземпляр Control Room, используемый для доступа к Bot Agent.
b) Нажмите функциональную клавишу F12, чтобы открыть окно разработчика.
c) Navigate to the Security tab and click the View certificate option.

The Certificate Viewer window appears.
d) In the Details tab, click the Export option.
e) Select a Base-64 encoded option from the Save as type drop-down list.
f) Save the file to a location of your choice.

2. Чтобы импортировать сертификат, выполните следующие действия:
a) Open a command window.
b) Введите MMC, чтобы запустить окно консоли.
c) Select the Add/Remove Snap-in option from the File menu.
d) Double-click Certificates option and then select Computer account in the Certificates snap-

in window.
e) Click Next and select the Local Computer option in the Select Computer window.
f) Click Finish.
g) Click OK to return to the console window.

3. Now add the certificates to the Trusted Root Certification Authorities and Trusted Publishers
folders.
a) Double-click the Certificates name.
b) Right-click the Trusted Root Certification Authorities name.
c) Select the Import option from the All Tasks menu.
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The Certificate Import Wizard is launched.
d) Щелкните Вперед.
e) Click Browse and select the certificate that was saved.
f) Click Next and select the option to place all certificates in a store.
g) Click Next and click Finish to import the certificates.

Сертификат успешно импортирован.
h) Repeat the above steps to import certificates in the Trusted Publishers folder.

Теперь в окне консоли отображаются импортированные сертификаты для текущего
пользователя.

4. Перезапустите устройство Bot Agent, чтобы убедиться, что устройство успешно
зарегистрировано.

Подробнее о порядке устранения неполадок см. в разделе Automation 360: Error while registering device -
An unexpected problem occurred (A-People login required).

Preparing for users
After completing initial installation and depending upon your deployment option, the post-installation
configuration and validation, you are ready to prepare for users to login and work with боты.
См. раздел Пользователи.

Пробные лицензии
Для пробной лицензии Automation Anywhere Control Room устанавливается ознакомительный период
в 30 дней. Это дает пользователю возможность оценить продукт и принять обоснованное решение.
Пробные лицензии предлагают три Bot Creator и два Bot Runner для начала; также пользователь
может обратиться к системному администратору или в отдел продаж Automation Anywhere для
приобретения новой лицензии или продления существующей пробной лицензии.
Чтобы приобрести продленную лицензию или установить новую лицензию, необходимо выполнить
указанные ниже действия.
1. Войдите в Control Room в качестве администратора, после чего откроется главная страница

информационной панели.
2. Отображается уведомление с указанием дней, оставшихся до истечения срока действия

лицензии. Щелкните Показать детали. Появится сообщение со ссылкой Установить
новую лицензию или обратиться к системному администратору или в отдел продаж
Automation Anywhere

Для просмотра лицензии бот и статистики использования перейдите в раздел
Администрирование > Щелкнуть лицензии.

Прим.:  Статистика пользователей лицензий продуктов и бот видна только пользователям с
функцией администратора и пользователям с разрешением на управление лицензиями,

На странице «Лицензия» отображается статистика пользовательских лицензий продукта и бот с
подробными сведениями.
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Настройка аутентификации SAML
Switch an authenticated environment Control Room database to a SAML identity provider (IdP).

Прим.:  Интеграция SAML необратима. After it has been established, you cannot modify the
configuration.

Ensure that you are logged in to the  as the administrator.
Before you set up authentication for the Control Room, setup tasks (such as introducing credentials on
a new system and importing users) might be required. If you import users, then you must also include
matching user IDs, email addresses, first and last names, in both the Automation Anywhere credentials
and matching records to log in after the SAML integration. For example, if using Okta as a SSO, then users
must have matching IDs, email addresses, first name and last names in both Automation Anywhere and
Okta to log in after the SAML integration.
You should have the required user information and certificate ready. Typical user information consists of
user ID, first and last name, and an email address.

Прим.:  You must validate the SAML IdP setup before you configure the Control Room. См. раздел
Configure the Control Room as a service provider.

After switching to SAML authentication environments, any users with non-SAML IdP formatted IDs will not
be able to log in. You need to verify that any боты located in their private folders are exported so they can
be imported back against their new user accounts.
Much of this configuration relies on third-party applications to create the necessary metadata. If
you require more specific configuration information based on a specific provider, see Configure SSO
authentication with Okta.
To switch the Control Room to a SAML-authenticated environment, follow these steps.
1. Navigate to Administration > Settings > User authentication.
2. Выберите параметр Использовать SAML.

Прим.:  По умолчанию выбран параметр Использовать базу данных Control Room.

3. В поле Уникальный идентификатор объекта для Control Room (поставщика услуг)
введите идентификатор объекта.

4. В поле Зашифровать утверждения SAML выберите один из указанных ниже параметров.
Опция Описание

Не шифровать Утверждения SAML не шифруются.

Зашифровать Утверждения SAML шифруются.

5. Необязательно: Введите значения Открытый ключ и Закрытый ключ.

Прим.:  Вводите ключи только в том случае, если вам требуются зашифрованные утверждения
SAML.

6. Щелкните Проверьте настройки SAML.
The Control Room will log in through the SAML provider and redirect back to the Control Room User
Authentication page.
Если щелкнуть по этому параметру, вы будете перенаправлены на веб-страницу поставщика
услуг SAML 2.0, где вам будет предложено ввести учетные данные и другую информацию.

7. Log in to your provider when prompted.
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8. Щелкните Сохранить изменения.

Задачи, связанные с данной
Configure the Control Room as a service provider
A valid SAML IDP setup must be configured before the Control Room can be switched to a SAML-
authentication environment.

Configure SSO authentication with Okta
To log in after SAML integration, configure single sign-on (SSO) authentication with Okta as identity
provider (IDP).

Прим.:  Okta is a third party and might update their user interface (UI) anytime. Hence, the Okta UI
references and images here are indicative and meant only for basic guidance.

Обеспечьте выполнение приведенных ниже требований.
• The Control Room is a secure environment.
• A secure Automation 360 Cloud tenant is used.

1. Create a user in Okta and an admin account in Automation 360.

Прим.:  The user must be created with the same User ID, , First Name, Last Name, and Email Address.
You might need to use email address for User ID. During testing, only email address is allowed in
Okta.

2. Generate an SSL certificate with private and public keys.
These keys are required to encrypt the communication between Okta and Automation 360.

3. Create app integration.
4. Assign application to the user.
5. Configure the Control Room.
6. Validate the connection.

Create app integration
Configure Okta on a system before you import users and perform other setup tasks. Create SAML
integration in Okta and set the advanced settings and attributes.
When you import users, ensure that they have a matching user ID, email address, first name, and last
name in both Automation 360 and Okta to log in after the SAML integration.
1. In Okta, navigate to Applications and click Create App Integration.

2. Select the SAML 2.0 sign-in method and click Next.
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3. In the App name field, enter the name of the app and click Next.

4. Enter the Single sign-on URL.
It is the Assertion URL on the Control Room in the <CRURL>/v1/authentication/saml/assertion format.

5. Enter the Audience URI.
This can be any word or phrase (no spaces). Make note of this term to use in the Control Room
configuration.

6. Click Show Advanced Settings.
7. In the Advanced Settings section, select the Assertion Encryption as Encrypted.
8. For Encryption Certificate, click Browse files and select the public key certificate that you

generated.
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9. Scroll down to the Attribute Statements section and enter attributes, and then click Next.

10. Select the appropriate option to notify whether you are a customer or a vendor, and then click Finish.
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11. Scroll down and click View Setup Instructions.

The Identity Provider metadata field at the bottom is used in the Control Room configuration.

Assign application to user

Assign application to user
After the application is created, assign it to the user.
1. In Okta, navigate to the Applications > Assignments tab.
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2. Click Assign and select Assign to People.
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3. Click the Assign link that is next to the required user and confirm the assignment, and then click
Done.

Configure Control Room for Okta user

Configure Control Room for Okta user
After the application is assigned to the user, configure the Control Room for a user assigned in Okta.
1. Log in to the Control Room as the same user configured in Okta (User ID as Email address on both

systems).
2. Navigate to Administration > Settings > User authentication.
3. Select Use SAML.

Прим.:  Use Control Room database is selected by default.

4. В поле Уникальный идентификатор объекта для Control Room (поставщика услуг)
введите идентификатор объекта.

5. В поле Зашифровать утверждения SAML выберите один из указанных ниже параметров.

© 2023 Automation Anywhere. All rights reserved.     1007



    Automation Anywhere - Install and update Automation 360

Опция Описание

Не шифровать Утверждения SAML не шифруются.

Зашифровать Утверждения SAML шифруются.

6. Необязательно: Введите значения Открытый ключ и Закрытый ключ.

Прим.:  Enter the keys only if you require encrypted SAML assertions.

Validate the connection

Validate the connection
After the Control Room is configured, validate the SAML settings.
1. Щелкните Проверьте настройки SAML.

The Control Room will log in through the SAML provider and redirect back to the Control Room User
Authentication page.
When you click this option, you are redirected to a SAML 2.0 service provider web page where you are
prompted to enter the credentials and other data.

2. Log in to Okta when prompted and click Save changes.

Редактировать профиль
Manage user profiles.
For users of Control Room configured with a non-directory environment, change the password, first name,
last name, and email address.
1. Click the Device icon and select Update credentials.

In the Control Room panel, click your username and select the My settings link.
2. In the Device login credentials section, enter the Username and Password for the device.

In the My profile section, click Edit.
Device login credentials are required to run a бот from this device.

Прим.:  Automation 360 does not validate the device login credentials until you run a бот.

If your username is part of a domain, include the domain within the format domain\username.
Typically, home users are not part of a domain, unless they are specifically configured.
If your username contains non-ASCII characters, ensure your system locale settings are configured to
use these characters.
Configuring post-installation settings

3. Enter information for general details, contact info and change password.
4. Click Update

Save the changes.

Installed Control Room directories and files
When installing the Automation Anywhere Control Room on different operating systems, the installer
executes and installs files and folders in the following directories.
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Window OS directory structure

When you install the Automation Anywhere Control Room on Windows OS, the default installation directory
for many configuration files is located:
C:\Program Files\Automation Anywhere\

Linux OS directory structure

When you install the Automation Anywhere Control Room on Linux OS, the installer creates the following
directories.

Directory path Описание Комментарии

/opt/automationanywhere/automation360 All binary files

/opt/automationanywhere/automation360/
config

Config files

/var/log/automationanywhere/
automation360

Log files

/tmp Temporary files Directory that
contains temporary
files created by the
system and users.
Files under this
directory are
deleted when the
system is rebooted.

/opt/automationanywhere/automation360/
appdata/Server Files

Server files Control Room
repository folder.

/opt/automationanywhere/automation360/
_Automation 360_installation/Logs

Installer logs Installation logs
provide details
about issues during
installation, if any.

Configuration files

Прим.:  Automation 360 supports UTF-8 file encoding type. When you edit or create any Bot Agent or
Control Room configuration file, ensure to use UTF-8 file encoding type.

The minimum installed configuration files include:
• Installation license keys - Request the installer and appropriate license keys from your account

manager.
• Bot Creator schedules configuration files

• Log file name: logging.properties
• Log file location: <install_location>\config
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• Auto-login configuration files
• Configuration file name: autologinhelper-logging.xml
• Configuration file location: C:\Program Files\Automation Anywhere\Bot Agent\config

• Device configuration files
• Configuration file name: settings.properties
• Configuration file location: <install_location>\config

• Database configuration files
The database connection string is configured in:
• Configuration file name: boot.db.properties
• Configuration file location: <installation_location>\config

Additional configuration files that are created as needed, include:
• Cluster configuration

• Configuration file name: cluster.properties
• Configuration file location:<installation_location>\config\

• Key distribution center (KDC)
• Configuration file name: um.properties
• Configuration file location: <installation_location>\config\

• Parallel repository tuning
• Configuration file name: boot.server.properties
• Configuration file location: <installation_location>\config\

• Remote Desktop Protocol (RDP)
• Configuration file name: deployment.properties
• Configuration file location: <installation_location>\config\

• URL resources
• Configuration file name: DWMP_CONNECTIONS.properties
• Configuration file location: <installation_location>\DWAService\bin\src\main

\resources

• Trusted list restrictions
• Configuration file name: repository.properties
• Configuration file location:<installation_location>\config\

• Управление рабочей нагрузкой
• Configuration file name: wlm.properties
• Configuration file location:<installation_location>\config

Статус безопасного режима Control Room
Control Room подключается к серверу лицензий Automation Anywhere Cloud и получает
лицензионные права на основе лицензионного ключа, установленного в Control Room.
Control Room может перейти в безопасный режим в одном из следующих сценариев.
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1. Когда Control Room не может подключиться к серверу лицензий, выполняется переход в
безопасный режим.

2. Когда превышен лимит подписок на Control Room, то Control Room переходит в безопасный
режим.

С точки зрения базы данных сервера лицензий Control Room, Control Room находится в одном из
трех состояний. Эти состояния указывают, какие действия по лицензированию пользователей можно
выполнить. При каждом изменении состояния в журнале аудита создается запись.

Активный Нормальная работа. Все API-вызовы из Control
Room принимаются сервером лицензий.
При входе пользователям могут быть
назначены плавающие лицензии. При
выходе пользователей плавающие лицензии
освобождаются.
Когда Control Room перезапускается и начинает
работать, а подключение к серверу лицензий
установлено, Control Room находится в активном
состоянии.
• Для пользователей, которым лицензии были

назначены до перехода в безопасный режим,
перераспределяются их первоначальные
лицензии.

• Новые пользователи могут запрашивать и
получать лицензии.

Безопасный режим На сервер лицензий можно отправить только
API-вызов типа «heartbeat». Все остальные
вызовы из Control Room прекращаются.
• Порог перехода в безопасный режим:

если лицензия не получает heartbeat-сигнал
от Control Room в течение 48 часов, то сервер
лицензий считает, что Control Room работает
в безопасном режиме. Этот 48-часовой
период называется порогом перехода в
безопасный режим.

Истек срок действия безопасного режима Control Room останавливает все операции, и
для всех пользователей выполняется выход из
Control Room.
• Порог истечения срока действия

безопасного режима: после перемещения
Control Room в безопасный режим,
сервер лицензий ждет до 30 дней,
чтобы восстановить лицензию. По
истечении 30 дней статус изменяется
на Приостановлено и вам необходимо
подключиться к службе технической
поддержки для восстановления Control Room
в безопасном режиме.
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Переход в безопасный режим Истечение срока действия
безопасного режима

Из-за потери
подключения

Из-за
чрезмерного
потребления
лицензий

Из-за потери
подключения

Из-за
чрезмерного
потребления
лицензий

Дни Через два дня
после потери
подключения

Через два
дня после
чрезмерного
потребления

30 дней с
момента
перехода в
безопасный
режим

30 дней с
момента
перехода в
безопасный
режим

Причина Потеря
подключения/отключение
сервера лицензий

Чрезмерное
потребление
лицензий Если
пользовательских
лицензий
используется
больше, чем
выделено, Control
Room отображает
сообщение о
чрезмерном
потреблении.

Потеря
подключения/отключение
сервера лицензий

Чрезмерное
потребление
лицензий
(Используется
больше
лицензий, чем
приобретено.)

Решение Восстановить
подключение

Освободите
используемые
сверх нормы
лицензии и
синхронизируйте
лицензии
с сервером
лицензий
или обновите
лицензии.
• Вы можете

удалить
лишние
лицензии,
связанные с
пользователями,
и выполнить
повторную
синхронизацию
с сервером
лицензий,
щелкнув
Синхронизировать
лицензию с
сервера.

Восстановить
подключение

1. Продлите
используемую
сверх нормы
лицензию.

2. Отправьте
заявку в
службу
поддержки
для
восстановления
перехода в
безопасный
режим,
а затем
освободите
используемые
сверх нормы
лицензии и
синхронизируйте
данные с
сервером
лицензий.
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Переход в безопасный режим Истечение срока действия
безопасного режима

Из-за потери
подключения

Из-за
чрезмерного
потребления
лицензий

Из-за потери
подключения

Из-за
чрезмерного
потребления
лицензий

Возможные
операции

1. Разрешены
только
распределение
и отмена
распределения
лицензий.
После
восстановления
подключения
данные
синхронизируются.

2. Выполнить
вход
могут как
администраторы,
так и не
являющиеся
ими
пользователи.

3. При входе
отображается
баннер и
сообщение
об ошибке
на странице
лицензии.

4. Операции
RPA
продолжают
выполняться
в обычном
режиме.

1. Разрешены
все операции
с лицензиями

2. Выполнить
вход
могут как
администраторы,
так и не
являющиеся
ими
пользователи

3. При входе
отображается
баннер и
сообщение
об ошибке
на странице
лицензии,
а также
ошибка
чрезмерного
потребления
лицензий
на странице
лицензии.

4. Операции
RPA
продолжают
выполняться
в обычном
режиме.

1. Выполнить
вход может
только
администратор.
Пользователи,
не
являющиеся
администраторами,
не могут
выполнить
вход.

2. Операции с
лицензиями
запрещены

3. При входе
отображается
баннер и
сообщение
об ошибке
на странице
лицензии.

4. Операции
RPA не могут
выполняться.

1. Администратор
может
выполнить
вход и
установить
лицензии.

2. Операции с
лицензиями
запрещены

3. Баннер
показывается
в последний
день перед
отключением
Control Room
вместе с
ошибкой
чрезмерного
потребления
на странице
лицензии

4. Операции
RPA не могут
выполняться.

Уведомления По истечении
первых 48 часов
вы увидите в
Control Room
баннер и
сообщение о
чрезмерном
потреблении.

On the 30th day,
you will see the
banner with a red
background and a
post that the user
will not be able to
log in. After the
30th day, you will
not be able to use
the Control Room.

Понятия, связанные с данным
Лицензии и облачные сервисы
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Портал «Лицензии и облачные сервисы» позволяет управлять лицензиями, экземплярами Cloud
Control Room и облачными сервисами RPA, связанными с вашей учетной записью. Вам, как клиенту
или партнеру Automation Anywhere и администратору RPA, Control Room или ИТ-администратору,
необходимо эффективно управлять всей системой ИТ-активов, чтобы реализовать ценность своих
инвестиций.
Ссылки, связанные с данной
Лицензии Automation 360
На странице Все лицензии отображается подробная информация о текущих лицензиях продукта и
устройства.
Уведомления об истечении срока действия лицензии Control Room
Уведомления об истечении срока действия лицензии Automation Anywhere Control Room появляются,
когда подходит к концу срок действия лицензии Control Room.

Лицензии и облачные сервисы
Портал «Лицензии и облачные сервисы» позволяет управлять лицензиями, экземплярами Cloud
Control Room и облачными сервисами RPA, связанными с вашей учетной записью. Вам, как клиенту
или партнеру Automation Anywhere и администратору RPA, Control Room или ИТ-администратору,
необходимо эффективно управлять всей системой ИТ-активов, чтобы реализовать ценность своих
инвестиций.
Основными функциональными возможностями, предоставляемыми порталом «Лицензии и облачные
сервисы», являются управление лицензиями и управление облачными сервисами для
клиентов и партнеров.
Клиенты с помощью этого портала могут выполнять указанные ниже задачи.
• Предоставление облачных сервисов и управление ими.
• Получение сведений о глобально уникальных идентификаторах (GUID) лицензий, обслуживаемых

из облака лицензий.
• Настройка и загрузка файлов лицензий (если применимо).

Партнеры с помощью этого портала могут выполнять указанные ниже задачи.
• Предоставление своих облачных сервисов и облачных сервисов своих клиентов и управление

этими сервисами.
• Получение подробной информации о собственных и принадлежащих клиентам идентификаторов

GUID облачных лицензий, обслуживаемых из облака лицензий.
• Настройка и загрузка файлов лицензий для себя и своих клиентов.

Обзор

Для эффективного использования окружения и управления им администраторам ИТ и RPA
необходима видимость лицензионных прав и возможность просмотра доступных и используемых
лицензий в реальном времени. Кроме того, этим администраторам необходима видимость
приобретаемых облачных сервисов и экземпляров сервисов для эффективного управления
требованиями к RPA в своих организациях. Портал помогает этим пользователям собирать данные,
просматривать лицензии и облачные сервисы и управлять ими.
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Доступ к порталу

Получить доступ к порталу «Лицензии и облачные сервисы» можно на сайте A-People. Для этого
необходимо иметь учетную запись на A-People и быть назначенным пользователем портала в рамках
процесса продаж.
1. Войдите на A-People, используя свои учетные данные: A-People home page (login required)

2. Щелкните по вкладке Лицензия и облачные сервисы.
Или же перейдите непосредственно на эту страницу, щелкнув ссылку, предоставленную в
приветственном письме.

Управление лицензиями

С помощью портала «Лицензии и облачные сервисы» можно управлять указанными ниже типами
лицензий продуктов.

Лицензии Cloud Лицензионные права на программное
обеспечение, которые распространяются и
управляются сервером облачных лицензий
Automation Anywhere. Control Room
подключается к серверу облачных лицензий
Automation Anywhere и получает лицензионные
права на основе лицензионного ключа,
установленного в Control Room.
Лицензионный ключ имеет вид GUID и доступен
на портале. Экземпляры Automation 360 Cloud
и On-Premises Control Room, имеющие доступ к
серверу облачных лицензий, могут использовать
облачные лицензии.

Файловые лицензии Файловые лицензии в основном используются
для версий Automation Anywhere Enterprise 11
и Enterprise 10 и для некоторых развертываний
Automation 360 On-Premises Control Room.
На портале для каждой Control Room можно
сгенерировать один файл лицензии и вручную
установить в Control Room.

Клиенты и партнеры могут выполнять указанные ниже задачи, связанные с лицензиями.
• Просмотр всех лицензионных прав и получение подробной информации о приобретенных и

доступных лицензиях и условиях подписки (даты начала и окончания действия лицензии).
• Настройка и загрузка файлов лицензий по мере необходимости.
• Просмотр всех лицензионных прав и получение подробной информации о GUID для облачных

лицензий.
• Как партнер, вы можете просматривать лицензионные права для своей компании и для своих

конечных клиентов и управлять этими правами.
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Управление облачными сервисами

Используйте портал «Лицензии и облачные сервисы» для управления указанными ниже типами
сервисов Cloud Control Room.
• Чистая Cloud Control Room
• Чистая облачная Control Room песочницы
• Control Room с поддержкой облака
• Control Room песочницы с поддержкой облака
• Миграция в облачную Control Room

Экземпляры чистой Cloud Control Room и чистой облачной Control Room песочницы должны явным
образом предоставляться пользователем клиентской лицензии (Customer License User; CLU) по
запросу, когда клиент готов к использованию облачного сервиса.
Экземпляры Control Room с поддержкой облака и Control Room песочницы с поддержкой облака
автоматически предоставляются порталом «Лицензии и облачные сервисы», обеспечивая
пользователя токеном CLU, необходимым для установки Control Room с поддержкой облака в его
инфраструктуре.
Клиенты и партнеры могут выполнять указанные ниже задачи, связанные с облачными услугами.
• Просмотр списка всех сервисов Cloud Control Room по подписке с визуальным отображением

параметров конфигурации, связанных с облачным сервисом.
• Предоставление облачных сервисов по запросу, таких как Cloud Control Room и IQ Bot. Это

помогает обеспечить предоставление сервисов в режиме реального времени.
• Доступ к заказанным сервисам Control Room и управление ими.
• Миграция сервисов Control Room для производства и тестирования.

Управление облачными и файловыми лицензиями
Портал «Лицензии и облачные сервисы» включает указанные ниже основные вкладки. «Управление
файловыми лицензиями», «Управление облачными лицензиями», «Экземпляры Cloud Control Room»,
а также «Выборка партнеров».
Управление облачными лицензиями
На вкладке для клиентов и партнеров представлен обзор всех лицензионных прав в облаке и
лицензионных ключей (GUID), которые будут применяться ко всем клиентским экземплярам Control
Room.
Для пользователей On-Premises Automation 360: назначенный пользователь может получить GUID
Control Room на этой вкладке и вставить его в соответствующий экземпляр Control Room. См.
Installing additional licenses.

Прим.:  Для новых пользователей Cloud Automation 360: новым клиентам эта вкладка служит
только для справки, потому что когда Cloud Control Room подготавливается в первый раз, GUID уже
применяется к их экземпляру Control Room.

Управление файловыми лицензиями
На вкладке Управление файловыми лицензиями клиенты и партнеры могут ознакомиться со
всеми доступными лицензионными правами на файлы. Назначенные пользователи лицензий могут
настроить файл лицензии для каждого из своих экземпляров Control Room с необходимыми правами.
Подробнее см. в разделах Manage licenses и Installing additional licenses.
Приведенные ниже шаги являются руководством по лицензированию Automation 360 и Enterprise 11.
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1. В представлении списка Control Room щелкните по имени Control Room, доступному в виде
гиперссылки.
Гиперссылка перенаправляет вас на страницу настройки лицензии, где можно выбрать права,
которые необходимо добавить к Control Room, а также сохранить и сгенерировать файл
лицензии.

Прим.:  Порталу требуется несколько минут, чтобы сгенерировать файл.

2. Используйте параметр Обновить чтобы узнать, создан ли файл лицензии.
После изменения статуса Control Room на Активно можно снова щелкнуть по имени Control
Room и загрузить файл.

3. В соответствии с потребностями вашего бизнеса, можно перенастроить файлы лицензий в
любой момент на той же вкладке.
Можно настроить только права со статусом Доступно. Если все права используются в файлах
лицензий, необходимо перенастроить файл, чтобы разблокировать права и сделать их
доступными для добавления в другой файл лицензии.

Подробнее см. в указанных ниже видеороликах.

Для партнеров: на странице отображается дополнительный раскрывающийся список, который
позволяет переключать контекст между несколькими клиентами, которыми вы управляете. На
странице представлены аналогичные элементы, а также дополнительный раскрывающийся список,
который позволяет партнерам переключать контекст между различными правами клиентов.

Лицензии Automation 360
На странице Все лицензии отображается подробная информация о текущих лицензиях продукта и
устройства.

Лицензии продуктов

Automation Anywhere Control Room — это центральное веб-приложение Digital Workforce,
обеспечивающее управление и контроль в масштабах всего предприятия. Control Room
обеспечивает надежность, масштабируемость и безопасность развертывания и выполнения бота.
Благодаря централизованному приложению операторы могут простым щелчком мыши получать
задачи от Bot Creator и передавать их в Bot Runner для выполнения. Control Room контролирует и
проверяет все запланированные и выполняемые боты в режиме реального времени.
Control Room предоставляет автоматизированный механизм для отслеживания и контроля
использования лицензионного программного обеспечения в Bot Creator и Bot Runner в соответствии
со стандартом NIST Change Management CM-10.

Лицензии устройства

В разделе лицензий устройства отображается количество приобретенных, использованных и
доступных лицензий. Если лицензии добавлены в Control Room из Cloud, на странице «Лицензии»
также отображается количество страниц, обработанных в других экземплярах Control Room.
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Лицензия Разрешение

Bot Creator Users with this license can create, edit, schedule, and
trigger боты. Additionally, these users can run боты in the
following ways:
• On their local machine
• From the public workspace if the Control Room

administrator has specified a Run as user for
unattended Bot Runner

Лицензия на среду выполнения Bot
Runner без сопровождения

Пользователи с этой лицензией могут выполнять
все задачи автоматизации, которые доступны
пользователям с сопровождением. Кроме того, эта
лицензия может быть использована для развертывания
Automation Anywhere Control Room, централизованного
планирования и развертывания на основе API.

Прим.:  Среди всех триггеров можно связать
какой-либо триггер только с пользователем, имеющим
лицензию Bot Runner. Кроме того, если связываются
такие триггеры, как «Горячая клавиша», «Интерфейс»
или «Окно», для пользователя с лицензией Bot Runner
без сопровождения применяются указанные ниже
условия.
• Устройство по умолчанию не должно

находиться в состоянии «выход из системы» или
«заблокировано».

• Для выполнения предопределенной задачи, которая
может инициировать бот, пользователь должен
войти в систему устройства.

Лицензия на среду выполнения Bot
Runner с сопровождением

Пользователи с этой лицензией могут запускать боты
на своих устройствах. Однако эти пользователи не
могут запускать или планировать запуск боты на
другом устройстве.

Лицензия Непрофессиональный
разработчик

Пользователи с этой лицензией могут создавать и
запускать боты (включая боты с триггерами) на своих
устройствах.
Create a Непрофессиональный разработчик role

IQ Bot pages (Number of pages) This license is required for uploading documents to
Automation 360 IQ Bot.

Стандартные формы pages (Number
of pages)

This license is required for uploading documents for
processing in Стандартные формы.

Google Document AI (Number of
pages)

Позволяет пользователям Document Automation
обрабатывать документы в Google Document AI.

Прим.:  Это измерение видно только тем клиентам,
которые приобрели лицензии Google Document AI через
Automation Anywhere.
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Лицензия Разрешение

Document Automation Стандартные
формы (Number of pages)

This license is required for processing documents in
standard forms in Document Automation.

Document Automation 360 Extraction
(Number of pages)

This license is for processes documents in an Automation
Anywhere (Pre-trained) model, including the User-defined
document type.

Классификатор IQ Bot Пользователи с этой лицензией могут загружать
документы в классификатор, где они сортируются по
группам, что повышает точность извлечения.

Bot Insight Bot Insight предоставляет аналитику на основе RPA в
режиме реального времени. Эти данные охватывают
аналитику бизнес-процессов и операций.
Лицензия Bot Insight приобретается на одного
пользователя. Чтобы получить доступ к Деловой
информационной панели, пользователю должна быть
назначена эта лицензия.

Automation Anywhere Robotic
Interface (AARI)

Users with the Automation Anywhere Robotic Interface
license can be added to a Team for Process Composer
consumption. This allows them to create requests and
submit tasks within AARI

Discovery Bot Process Discovery licenses must be purchased for use for
business analysts and business users using Discovery Bot.
Discovery Botsupports two licenses. Бизнес-аналитики
используют лицензию «Анализатор процессов» для
просмотра и администрирования метаданных всех
записей в рамках процесса. Бизнес-пользователи
применяют лицензию «Средство записи процессов» для
просмотра, записи и отправки процессов с помощью
средства записи Discovery Bot.

RBAC для управления лицензиями

Доступ к управлению лицензиями запрещен для большинства пользователей и разрешен только
некоторым из них на основе функций и доменов, указанных в системе управления доступом на
основе функций (RBAC). Только те пользователи, у которых есть разрешение на управление
лицензиями, могут просматривать информацию о правах в Automation Anywhere Control Room.

Базовые элементы управления запасами: Bot Creator, Bot Runnerи Боты

Automation Anywhere Control Room управляет всеми операциями по автоматизации. Поддержка
элементов управления запасами осуществляется за счет применения RBAC для создания единой
точки контроля для базовых конфигураций (NIST CM-2), ограничений доступа для управления
конфигурацией (NIST CM-5 и 6). Можно настроить автоматическую отчетность по базовым
показателям.
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Лицензирование в условиях высокой доступности и аварийного
восстановления

Информация о лицензиях, которая централизованно хранится в базе данных или облаке лицензий,
также используется в кластерах высокой доступности и на сайтах с аварийным восстановлением,
поскольку между несколькими серверами Control Room настроена синхронная репликация данных.
HA and DR deployment models
Задачи, связанные с данной
Installing additional licenses
Upload new licenses to the Automation Anywhere Control Room to be distributed to users as required.
Ссылки, связанные с данной
Уведомления об истечении срока действия лицензии Control Room
Уведомления об истечении срока действия лицензии Automation Anywhere Control Room появляются,
когда подходит к концу срок действия лицензии Control Room.

Accessing Automation 360
Any new customer who orders our products receive license confirmation from Automation Anywhere.
The designated person responsible for configuring licenses for their company receives two email
confirmations.
The SSO email from sso@automationanywhere.com grants you access to set up a new
password for your Automation Anywhere Single Sign-On (SSO) account. The Orders email from
orders@automationanywhere.com grants you access to your license entitlement information.
Do the following:
1. Open SSO email → access link.
2. Enter and confirm new password.
3. Access A-People Community.
4. There are two options to access your license entitlements.

Вариант Действие

A-People Navigate to LICENSES.

Orders email Access link to redirect to license page.

Прим.:  Your license entitlement validation date is provided within the context of the Orders email
and on the A-People License configuration page.

5. You now have access to your license entitlements.
On this page, you have access to more information of your order. The Product Versions shows
your current license entitlement version, the License Entitlements shows the number of license
entitlements in your order, and the Control Rooms shows the number of control rooms in your order,
and allows to configure each licenses.

Provision Cloud Control Room instances
You can access, view, provision, and edit all the purchased Cloud Control Room instances. If required, you
can also purchase and provision the IQ Bot services later.
Use the Licenses and Cloud Services portal to provision Cloud Control Room and Cloud sandbox Control
Room instances on demand. Cloud-enabled Control Room instances are automatically provisioned by the
portal.
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Customers can provision their own Cloud Control Room instances, and partner users can provision Cloud
Control Room for themselves and their customers.
1. Войдите на A-People, используя свои учетные данные: A-People home page (login required).
2. Щелкните по вкладке Лицензии и облачные сервисы.
3. Слева на панели навигации щелкните по вкладке Экземпляры облачных Control Room,

чтобы отобразить список подготовленных и неподготовленных экземпляров Cloud Control Room
для различных типов экземпляров Cloud Control Room.
В представлении отображаются различные параметры, связанные с подготовленными
экземплярами Cloud Control Room, например имя домена, URL-адрес Control Room и регион
размещения Control Room. Use the region name to subscribe to maintenance notifications on
status.automationanywhere.digital.

4. В поле Имя Control Room введите имя.
5. В поле Имя домена облачной Control Room введите имя домена.

Имя домена должно быть уникальным, оно будет частью вашего URL-адреса Cloud Control Room.
Портал проверяет и валидирует уникальность имени домена во всей системе.
Рассмотрим следующие примеры имен доменов.
• Example URL for Cloud Control Room: https://<domain-name>.my.automationanywhere.digital
• Example URL for Cloud sandbox Control Room: https://<domain-

name>.cloud#.automationanywhere.digital

Прим.:  After provisioning is done, the domain name for a Cloud Control Room cannot be changed.

6. Выберите параметр Окружение.
Доступные параметры: Производство, Разработка и Приемочное пользовательское
тестирование (UAT). By default, for sandbox Control Room, only the sandbox option is displayed
here.

7. Выберите Страну, из которой большинство ваших пользователей будут получать доступ к этой
Control Room.
В зависимости от выбранной страны, ваша Cloud Control Room будет размещена в ближайшем
регионе.

Прим.:  После подготовки изменить параметр Страна для Cloud Control Room будет
невозможно.

8. Select your Region.

Прим.:  После подготовки изменить параметр Область для Cloud Control Room будет
невозможно.

9. Выберите и укажите администратора Cloud Control Room.
Можно выбрать из существующих контактных лиц клиентов или создать новую учетную
запись. Для создания учетной записи нового администратора введите следующие данные: имя,
фамилия и адрес электронной почты.

10. Необязательно: If your account is entitled for IQ Bot service, you can register for IQ Bot by selecting
the check box.

11. Click Save to provision the Cloud Control Room instance.

The Cloud Control Room instance is automatically provisioned, and the Control Room status changes from
Provision to Provisioning in-Progress. Provisioning takes some time to complete. When provisioning is
complete, the status changes to Provisioning Complete.
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Самостоятельная миграция Control Room
Управление процессом подготовки миграции благодаря возможностям самостоятельной миграции и
гибкости выбора ручной или автоматической миграции.
To perform the task, you must have a  administrator account with the required rights and permissions.
Завершите настройку миграции Control Room в облако перед подготовкой сервера IQ Bot с Control
Room, если лицензированы соответствующие права.

Прим.:  В настоящее время миграция в GCP не поддерживается.

1. Войдите на A-People, используя свои учетные данные: A-People home page (login required).
2. Щелкните по вкладке Лицензии и облачные сервисы.
3. Слева на панели навигации щелкните по вкладке Экземпляры облачных Control Room,

чтобы отобразить список подготовленных и неподготовленных экземпляров Cloud Control Room
для различных типов экземпляров Cloud Control Room.
В представлении отображаются различные параметры, связанные с подготовленными
экземплярами Cloud Control Room, например имя домена, URL-адрес Control Room и регион
размещения Control Room. Используйте имя региона для подписки на уведомления об
обслуживании на сайте status.automationanywhere.digital.

4. В поле Имя Control Room введите имя.
5. Выберите тип миграции.

• Миграция автоматизации с помощью Migration Utility. Подробнее см. в разделе Установка
утилиты миграции Cloud.

• Ручная миграция. Вы будете работать с новой Cloud Control Room.

6. В поле Имя домена облачной Control Room введите имя домена.
Имя домена должно быть уникальным, оно будет частью вашего URL-адреса Cloud Control Room.
Портал проверяет и валидирует уникальность имени домена во всей системе. Рассмотрим
следующие примеры имен доменов.
Пример URL-адреса для чистой Cloud Control Room: https://
<имя-домена>.my.automationanywhere.digital
Пример URL-адреса для чистой облачной Control Room песочницы: https://
<имя-домена>.cloud#.automationanywhere.digital

7. Выберите параметр Окружение.
Доступные параметры: Производство, Разработка и Приемочное пользовательское
тестирование (UAT). По умолчанию для Control Room песочницы, здесь отображается только
параметр «Песочница».

8. Выберите Страну, из которой большинство ваших пользователей будут получать доступ к этой
Control Room.
В зависимости от выбранной страны, ваша Cloud Control Room будет размещена в ближайшем
регионе.

Прим.:  После подготовки изменить параметр Страна для Cloud Control Room будет
невозможно.

9. Выберите вашу Область.

Прим.:  После подготовки изменить параметр Область для Cloud Control Room будет
невозможно.
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10. Выберите и укажите администратора Cloud Control Room.
Можно выбрать из существующих контактных лиц клиентов или создать новую учетную
запись. Для создания учетной записи нового администратора введите следующие данные: имя,
фамилия и адрес электронной почты.

11. To generate the migration code, click Save.
The View tab displays the migration code.

12. Copy the migration code to the Cloud Migration utility. This will export and import the data to
Cloud.

Прим.:  You can click the View tab for the following:
• View the migration code.
• Regenerate the migration code when the code is expired.
• Indicates that the Cloud Control Room is ready for use by displaying the user credentials.
• Displays the status of the Cloud Control Room during the migration process.

Прим.:  During the migration process, you can view the stages of migration: New, Consumed, Expired,
Renewed, or Complete.

Просмотр сведений о Control Room миграции в облако
Помимо сведений, которые отображаются для обычной Cloud Control Room, на этой странице
показан код миграции, который будет использоваться утилитой миграции.

Просмотр сведений о Control Room миграции в облако

Пользователи, которые запускают подготовку, и администраторы Control Room миграции в облако
получают электронное письмо с инструкциями о том, как получить код миграции, установить
утилиту миграции и запустить процесс миграции.
Здесь представлена дополнительная информация об этом процессе, связанная со Статусом
миграции, Кодом миграции и Датой истечения срока действия кода миграции.
Ниже перечислены важные сведения, которые необходимо отслеживать на этой странице для
администраторов.

Статус миграции Отображает текущий статус миграции
Код миграции Необходимый код, запрашиваемый для

завершения процесса миграции

Дата истечения срока действия кода
миграции

Если срок действия кода истек, для дальнейшего
использования необходимо сгенерировать новый
код миграции.

Manage and allocate licenses (partners)
Automation Anywhere partners can manage and process Licenses and Cloud services.
Partners can manage their and their customers entitlements from the portal. Partners access the Licenses
and Cloud portal in the following ways:
• Purchases Automation Anywhere licenses for their own use.
• Participates in a customer purchases Automation Anywhere licenses through the partner.
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• Partner draws down from their own license entitlements and allocates some portion of the entitlements
to a customer.

Use the Select an Account to switch entitlements via the drop-down list. Partners can view license
entitlements, configure licenses (file-based licensing), view Control Room GUIDs (cloud-based licensing),
and view and manage provision ready cloud services (Control Room, IQ Bot server).
For information, see Управление облачными и файловыми лицензиями.
Assigning a customer and entitlements
To draw down on entitlements and assign to a customer, perform the following tasks.
1. Log in to the A-People portal: A-People home page (login required).
2. Click the Licenses and Cloud Services tab, and navigate to the Partner Draw downs tab.

An empty page is displayed when you log in for the first time. After a few requests have been
processed, this page displays a list of draw-downs that you have processed.

3. To start a new draw-down process, click New.
4. From the New Partner Draw Down Request page, select an order from the drop-down list.

You can draw down from only one order at a time.
5. Enter the required information in the following fields:

• Assign to customer account: Customer account name
• Customer website: URL to the customer's website
• Customer name: Name of your customer contact
• Customer email: Email address of the customer contact

6. After entering the customer information, generate a partner draw down request (PDR) by specifying a
number for each of the products available.

7. Click Save to generate a new PDR.
The PDR is in submitted state.
First, generate the PDR, an email notification is sent to your accounts team for approval.
Once the PDR is validated and approved (or rejected), the partner who requested for the PDR will
receive an email notification. The PDR requesting partner has to then navigate back to the portal to
take appropriate action.

8. After approval, click Accept.
After acceptance, the license entitlements from the PDR are transferred from the partner to the
customer. If the PDR is rejected, you can see the reason for rejection.

Прим.:  If for any reason the draw down is no longer required, the partner can cancel the request at
this point.

9. Clone the PDR if required, make the necessary changes and resubmit the PDR.

Partners can refer to the customer documentation for managing licenses and provisioning cloud services.
• For configuring file licenses, see Configure new licenses.
• For provisioning of cloud services, see Provision Cloud Control Room instances.

The Licenses and Cloud portal provides the partners with an automated way to process draw downs for
their customers.
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View and edit Cloud Control Room instances
You can get a complete inventory view of all the Cloud Control Room instances and Migration Control
Rooms that have been purchased and linked to your account. You can check their provisioning status,
which can be Not Provisioned, Provisioning in progress, Provisioning complete, or Provisioning failed. You
can provision these instances as and when required.

1. Войдите на A-People, используя свои учетные данные: A-People home page (login required).
2. Click the License and Cloud Services tab to open the Licenses and Cloud Services portal.
3. Слева на панели навигации щелкните по вкладке Экземпляры облачных Control Room,

чтобы отобразить список подготовленных и неподготовленных экземпляров Cloud Control Room
для различных типов экземпляров Cloud Control Room.
В представлении отображаются различные параметры, связанные с подготовленными
экземплярами Cloud Control Room, например имя домена, URL-адрес Control Room и регион
размещения Control Room. Use the Region name to subscribe to any maintenance notifications on
status.automationanywhere.digital.

4. Click the View option for any of the provisioned Cloud Control Room instances.
It opens the page with the details about the Cloud Control Room instances, such as name and domain
name, provisioning status, service type (Pure Cloud, Cloud-enabled, Cloud Sandbox, and so on),
license GUID, provisioning date, Cloud-enabled token, type of environment in which the instance is
deployed, and cloud region where the instance is hosted.

5. Необязательно: On the displayed page, click Edit to change the Cloud Control Room name to a name
of your choice.

6. If your account is entitled for an IQ Bot service, register for it by selecting the check box in the
displayed page.

7. Click Save to apply the changes in the page.

Уведомления об истечении срока действия лицензии Control Room
Уведомления об истечении срока действия лицензии Automation Anywhere Control Room появляются,
когда подходит к концу срок действия лицензии Control Room.
Когда срок действия лицензии Control Room истекает, администратор при входе в Control Room
видит баннерное уведомление. Control Room ежедневно проверяет статус лицензии. За 30 дней
до истечения срока действия лицензии в Control Room отображается уведомление с указанием
количества дней, оставшихся до истечения срока действия лицензии. Баннер отображается
каждый раз, когда администратор выполняет вход в Control Room в течение последних 30 дней
перед истечением срока действия лицензии Control Room. Серьезность баннерного уведомления
становится критической в последние 7 дней перед истечением срока действия лицензии Control
Room. По мере приближения даты истечения срока действия уведомления отображаются более
настойчиво с указанными ниже интервалами обратного отсчета.
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• 30 дней. Когда до истечения срок действия лицензии остается 30 дней, на баннере Control Room
появляется удаляемое уведомление и соответствующее сообщение отображается на баннере до
тех пор, пока лицензия не будет продлена или не истечет срок ее действия.

• 7 дней. Когда до истечения срока действия лицензии остается семь дней или меньше,
появляется красный баннер с указанием даты истечения срока действия и ссылкой для
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продления лицензии. Это уведомление отображается на консоли до тех пор, пока не будет
продлено обслуживание или не закончится 30-дневный период истечения срока действия.

• 0 дней (срок действия истек). После истечения срока действия лицензии вы не сможете
использовать Control Room. Появится экран, подобный приведенному ниже, с неудаляемым
уведомлением.

Прим.:  Если в окружении SSO параметр установки лицензии не отображается после истечения
срока действия лицензии, очистите кэш браузера и обновите браузер. Параметр установки
лицензии будет отображаться.

См. также:

• Лицензии Automation 360
• Лицензии и облачные сервисы
• Статус безопасного режима Control Room
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Начните с Community Edition
Use these tasks to register for, and start creating and using боты with the Community Edition of
Automation 360.
1. Register for the Automation Anywhere Community Edition:

a) From the Automation Anywhere website https://www.automationanywhere.com scroll to and click the
Get Community Edition option.
Alternatively, select Customers & Partners > A People Community > Community Edition.
Scroll to the registration form: GET COMMUNITY TODAY.

b) Enter your identification information in the form that appears.
The form information includes your first name, last name, email, country, phone number, and
company. This information is used to create your Community Edition user login credentials.

Ограничение:  Only the period/dot (.) and at sign (@) are allowed in the email field. No other
special characters are supported.

c) Read and agree to the terms, privacy policy, and license agreement. Select and click Submit.
Wait for the email from Automation Anywhere that contains the information for you to log in to
the Community Edition. The email includes the Community Control Room URL, your username,
and assigned user password. After you log in, you are prompted to reset your password.

2. Вход в Automation Anywhere Control Room.
To log in to Automation 360, open the Control Room URL in your browser, enter your credentials in the
login screen, and click Log in.

3. Install the Bot Agent, register your device, and set user device credentials.
Установка Bot Agent и регистрация устройств | Set user device credentials

The Bot Agent is a lightweight application that enables you to run боты on your device by connecting
the device to the Control Room. To run боты on a local machine, install the Bot Agent and add the
local device to the list of enabled host devices.
To enable a device for running боты, set the local device credentials.
If you are using an operating system other than Windows, you will not be able to install the Bot Agent
at this time. See system requirements. However, you can still build боты using the Bot editor.

4. Создание первого бот.
Follow these steps to create your first бот that prints the message, Go be great!, the Automation
Anywhere version of Hello World!

5. Run your first бот.
Run a бот from the same device that you used to create the бот.

Watch the following videos that illustrate some of the steps in this task:
• Installing the Bot Agent in Automation 360:

• Building your first бот:

• Running your first бот in the Community Edition:
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Community capacity and limitations
Community users access and бот creation and running conditions.

Number of боты creators per Community
Edition user

Each Community Edition user can use one Bot
Creator and one attended Bot Runner at a time.
Community Edition user does not have access to
unattended Bot Runner licenses.

Number of боты created by Community
Edition user

Each Community Edition user can create multiple
боты.

Number of registered devices per Community
Edition user

Each Community Edition user can register multiple
devices, but only be logged in to one at a time, and
only run a бот on one device at a time.

Number of боты run by Community Edition
user

Each Community Edition user can run one бот at a
time on any one registered device.

Export боты function for Community Edition
user

Community Edition user cannot export боты from
the Control Room.

Import боты function for Community Edition
user

Community Edition user cannot import боты
downloaded from the Bot Store to the Control
Room.

Прим.:  In addition to these limitations, Community users do not have access to administrator settings,
Bot Insight, Bot Runner, IQ Bot, AARI, and Center of Excellence (CoE). To access these settings and
features, you must upgrade to Automation 360.

Вход в Automation Anywhere Control Room
Чтобы войти в Automation 360, откройте URL-адрес Control Room в браузере, введите свои учетные
данные на экране входа и нажмите кнопку Вход.
Получите подтверждение регистрации по электронной почте.
• Пользователи Automation 360: Отправляется вашим системным администратором.
• Пользователи Community Edition:

1. Зарегистрируйтесь для участия в Community Edition.

Начните с Community Edition

2. Отправляется Automation Anywhere с использование информации, которую вы предоставили
при регистрации.

В этом сообщении электронной почты содержится:
• URL-адрес Control Room
• Имя пользователя, учетные данные и маркеры подготовки (если применимо)
• Временный пароль

Сбросьте этот пароль при первом входе в систему.

Прим.:  If you use the Microsoft Internet Explorer browser to log in to the Control Room, a notification
banner is displayed indicating that support for Internet Explorer 11 is ending. Доступ в Control Room с

© 2023 Automation Anywhere. All rights reserved.     1029



    Automation Anywhere - Install and update Automation 360

помощью Internet Explorer будет невозможен. Starting from the Automation 360 v.25 release, you will be
prompted to access the Control Room through an alternative supported browser, such as Google Chrome
or Microsoft Edge (Chromium). Refer to the banner for details on how you can evaluate any potential
impact to your existing automations. Microsoft Internet Explorer 11 EOL FAQ

1. Откройте URL-адрес в браузере.
2. В форме Вход введите свое имя пользователя и пароль.

При первом входе в систему используйте пароль, указанный в вашем приветственном
сообщении эл. почты.

3. Пользователи, выполняющие вход первый раз: Измените свой пароль. Для пользователей
Cloud: создайте контрольные вопросы.
Форма изменения пароля и создания контрольных вопросов открывается автоматически при
первом входе в систему. Заполните форму.
a) Заполните поля Изменить пароль.

Введите свой текущий пароль, введите новый пароль и подтвердите новый пароль.
Пароль должен состоять из 8-15 символов и может содержать только следующие символы:
a-z, A-Z, 0-9, знак (@), дефис (-), знак подчеркивания (_), восклицательный знак (!), знак
номера (#), знак доллара ($), процент (%), амперсанд (&) и точка (.).

b) Для пользователей облака: В каждой паре полей вопросов и ответов введите вопрос и
ответ, которые вы должны будете вспомнить, если забудете свой пароль или потребуется
подтвердить вход.

c) Щелкните Сохранить и войти.

После первого входа в систему для изменения пароля щелкните username, выберите Изменить
пароль и заполните форму.

4. Необязательно: Выберите Запомнить мое имя пользователя для быстрого входа в Cloud
Control Room.

5. Необязательно: Щелкните Забыли пароль?, чтобы сбросить пароль.
Вам будет отправлено сообщение электронной почты со ссылкой на страницу, необходимую для
сброса пароля учетной записи.

6. Щелкните Вход.
Аутентификация учетных данных выполняется непосредственно в базе данных Cloud Control
Room или Community Control Room.

Прим.:  Когда вы осуществляете доступ к Enterprise Control Room с использованием выбранного
параметра Вход с Windows, для успешного входа в систему необходимо ввести FQDN.

Прим.:  Если вы введете неправильный пароль определенное количество раз в зависимости
от политики паролей, установленной вашим администратором, ваша учетная запись
заблокируется. В целях безопасности выполняется аудит неудачных попыток входа в систему.
Это позволяет администратору провести анализ и принять соответствующие меры.

Задачи, связанные с данной
Создание первого бот
Выполните следующие шаги, чтобы создать первый бот, который печатает сообщение (Go be
great!), версия Automation Anywhere Hello World!
Установка Bot Agent и регистрация устройств
Install Bot Agent on your local device and connect it to Control Room. In order to run боты on that local
device, ensure that you add it to the list of enabled host devices.
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Reset user password
The Control Room administrator generates an email process for the user to reset their password.

Сведения о Bot Agent
The Bot Agent is a lightweight application that enables you to run боты on your local device by connecting
it to Control Room. After installing the Bot Agent on a device, a registered user with role-based access
privileges can create, manage, and deploy боты on that device.

Bot Agent configuration

1. A Control Room administrator creates and shares the user credentials. You can then log into Control
Room using these sign in credentials.

2. After signing into Control Room, you install the Bot Agent and register your local device. This device is
then mapped to your username in Control Room.

3. The Bot Agent is registered as a Windows service (Automation Anywhere Bot Agent Service) on your
device and the Automation Anywhere extension is added to your browser.

4. The device communicates with the Control Room using WebSocket and stays connected.

Privilege mapping

A user is granted privileges governed by role-based access and assigned a device license by a Control
Room administrator. User is assigned a Bot Creator or Bot Runner license.
Bot Creator
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Users with this license can log into the Control Room from a browser to perform the following actions:
• Create, edit, or delete боты.
• Manage боты for using in Bot Insight, IQ Bot, and Bot Store.

Bot Runner
Users with this license can deploy боты from the Control Room. Additionally, a user can be assigned one of
the following Bot Runner licenses:
• Unattended Bot Runner license

Users with this license are can allow other Control Room users with the required role to run and
schedule automations in Control Room. These users are also referred as Run as users.

• Attended Bot Runner license
Users with this license are allowed to run attended automations on their devices from the Control
Room.

Прим.:  If you encounter black screen when running боты in unattended mode, see the following article
for troubleshooting steps.
Black screenshot while running the bot in unattended mode (A-People login required)

Задачи, связанные с данной
Установка Bot Agent и регистрация устройств
Install Bot Agent on your local device and connect it to Control Room. In order to run боты on that local
device, ensure that you add it to the list of enabled host devices.
Ссылки, связанные с данной
Совместимость Bot Agent
Перед установкой Bot Agent убедитесь, что он совместим с аппаратным и программным
обеспечением в вашем окружении.

Совместимость Bot Agent
Перед установкой Bot Agent убедитесь, что он совместим с аппаратным и программным
обеспечением в вашем окружении.
The latest version of Bot Agent is available for download and is compatible with the Control Room version
that is used.

Guidelines

• When you update the Bot Agent in Windows Server 2012 or earlier versions of the operating system,
you might encounter unexpected system reboots during the update because of the limitations in the
operating system.

• When the Bot Agent update is optional, you can continue to use the Bot Agent from any of the previous
(optional) releases, which will be compatible with the current release. For example, the Bot Agent
update is optional for v.26. So you can continue to use the Bot Agent from v.25 release.
You can download and install the latest version of Bot Agent anytime on your device. However, an alert
on the availability of a newer Bot Agent version is displayed on the login screen if you are connected to
a device that is running an older version of Bot Agent.

• If you want to use the latest version of packages from a new release, you might be required to update
to the latest version of the Bot Agent even if it is optional.

© 2023 Automation Anywhere. All rights reserved.     1032

https://apeople.automationanywhere.com/s/article/Commands-like-Object-Cloning-Image-Recognition-Keystrokes-Etc-Do-Not-Work-In-Unattended-Mode-When-Autologin-Is-Enabled-And-Error-Out-With-Black-Screenshot-On-Failure


    Automation Anywhere - Install and update Automation 360

Compatibility with release builds

Версия
Automation 360

Сборка Automation 360 Версия Bot Agent Обновление Bot
Agent

Automation
360 v.28

• Сборка 17464 (Cloud-Sandbox)
• Сборка 17464 (Community Edition)

• 21,240
• 21,240

Необязательно

Automation
360 v.27

• Сборка 16685 (On-Premises)
• Сборка 16701 (Cloud)
• Сборка 16701 (Community Edition)

• 21,230
• 21,230
• 21,230

Необязательно

Automation
360 v.26

• Сборка 15459 (On-Premises)
• Сборка 15459 (Cloud)
• Сборка 15450 (Community Edition)

• 21,222
• 21,222
• 21,222

Необязательно

Automation
360 v.25

• Сборка 15112 (On-Premises)
• Сборка 14304 (Cloud)
• Сборка 14304 (Community Edition)

• 21,210
• 21,210
• 21.210.14966

Необязательно

Исправление
Automation
360 v.24R2

• Сборка 13343 (Cloud,
общедоступная версия On-
Premises, песочница, Community
Edition)

• Сборка 13331 (On-Premises до
общедоступной версии)

• 21,200
• 21.1000.14009

Сборка On-
Premises до
общедоступной
версии: удалите
Bot Agent
21.1000.14009 и
установите Bot
Agent 21.200.

Необязательно

Automation
360 v.24

• Сборка 12350 (On-Premises)
• Сборка 12350 (Cloud)
• Сборка 12350 (Community Edition)

• 21.134 (On-
Premises)

• 21.134 (Cloud)
• 21.134

(Community
Edition)

Необязательно

Automation
360 v.23

• Сборка 11513 (On-Premises)
• Сборка 11513 (Cloud)
• Сборка 11524 (Community Edition)

• 21.121.12191
(On-Premises)

• 21.121.12191
(Cloud)

• 21.121.12202
(Community
Edition)

Необязательно
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Версия
Automation 360

Сборка Automation 360 Версия Bot Agent Обновление Bot
Agent

Automation
360 v.22

• Сборка 10526 (On-Premises)
• Сборка 10535 (Cloud и Community

Edition)

• 21.98.11198
• 21.100.11213

Необязательно

Automation
360 v.21

• Сборка 9664 (On-Premises)
• Сборка 9664 (Cloud и Community

Edition)

• 21.82.10342
• 21.82.10342

Требуется

Enterprise
A2019.20

• Сборка 8815 (On-Premises)
• Сборка 8846 (Cloud)

• 20.17.9493
(On-Premises)

• Cloud:
• 20.18.9528

(для
регионов
США-Запад
и Япония)

• 20.17.9518
(для
регионов,
отличных
от
США-Запада
и Японии)

Требуется

Enterprise
A2019.19

• Сборка 8147 (On-Premises)
• Сборка 8145 (Cloud и Community

Edition)

• 18.12.8825
• 18.12.8823

Требуется

Enterprise
A2019.18

Сборка 7560 (Cloud, On-Premises и
Community Edition)

16.19.8238 Необязательно

Enterprise
A2019.17

Сборка 7103 (Cloud, On-Premises и
Community Edition)

16.7.7774 Требуется

Enterprise
A2019.16

Сборка 6463 (Cloud, On-Premises и
Community Edition)

14.3.7141 Требуется

Enterprise
A2019.15

Сборка 5933 (Cloud, On-Premises и
Community Edition)

12.7.6609 Необязательно

Enterprise
A2019.14

Сборка 5322 (Cloud, On-Premises и
Community Edition)

12.1.6000 Требуется

Enterprise
A2019.13

• Сборка 4705 ( On-Premises)
• Сборка 4701 (Cloud и Community

Edition)

• 9.0.5383
• 9.0.5379

Требуется
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Версия
Automation 360

Сборка Automation 360 Версия Bot Agent Обновление Bot
Agent

Enterprise
A2019.12

• Сборка 4111 (Cloud и Community
Edition)

• Сборка 4105 (On-Premises)

• 7.0.4789
• 7.0.4783

Требуется

Enterprise
A2019.11

Сборка 3337 (On-Premises, Cloud и
Community Edition)

6.0.4015 Требуется

Enterprise
A2019.10

Сборка 2545 (Cloud, On-Premises и
Community Edition)

3.3.3211 Необязательно

Enterprise
A2019.09

Сборка 2094 (Cloud, On-Premises и
Community Edition)

3.0.2772 Требуется

Enterprise
A2019.08

• Сборка 1610 (только On-Premises)
• Сборка 1598 (Cloud и Community

Edition)

• 1.0.2288
• 1.0.2276

Необязательно

Enterprise
A2019.07

• Сборка 1089 (только On-Premises)
• Сборка 1082 (Cloud и Community

Edition)

• 1.0.1767
• 1.0.1760

Необязательно

Enterprise
A2019.06

Сборка 543 (Cloud, On-Premises и
Community Edition)

1.0.1221 Необязательно

Enterprise
A2019.05

Сборка 336 (Cloud, On-Premises и
Community Edition)

1.0.1014 Требуется

For information on Bot Agent device requirements, see Device requirements for Bot Agent.
Задачи, связанные с данной
Установка Bot Agent и регистрация устройств
Install Bot Agent on your local device and connect it to Control Room. In order to run боты on that local
device, ensure that you add it to the list of enabled host devices.
Ссылки, связанные с данной
Матрица сравнения функций Automation 360
Используйте матрицу сравнения функций для сравнения функций Automation 360 с функциями в
Automation Anywhere Enterprise 11.3.x и версиях Enterprise 10.
Universal Recorder supported applications and browsers
Use the Universal Recorder to record interactions with objects from the supported technologies.

Auto-login support for Bot Agent
Use auto-login to automatically log on to a device, run a scheduled automation, and restore the device to
its original locked or logged off state after running the automation.
The Run as user device credentials are used for Auto-login. Auto-login restores a device to its original
state in the following scenarios:
• Automation was stopped on the Control Room or device.
• An error in encountered during бот execution.
• When the automation completed successfully.
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Auto-login support: operating system

Identify the operating system support specific to auto-login on Bot Agent devices. The auto-login process
involves several stages and depends on the Bot Agent activity.
The following scenarios are supported on Windows 10 and virtual machines only:

SID# Scenario

1 No user session established (user is not logged in)

2 User session established

3 User has logged in but locked the screen

4 A different user (not the device login user used for deployment) is logged
in

5 A different user is logged in and locked the screen

6 Fast user switching

The following scenarios are applicable and supported on Windows Server 2019, Windows Server 2016,
Windows Server 2012 R2, Windows 10, 8, and 7:

SID# Scenario

1 No active RDP session

2 User has active RDP session

3 User's RDP session is disconnected

4 User's RDP session is locked

5 Another user has active RDP session

6 Another user has a disconnected session

7 Another user has an active session and locked

Auto-login support: operating system with cloud platform

The following table identifies the support specific to auto-login on Bot Agent devices for operating system
across cloud platforms:

SID# Scenario Supported OS

1 No active RDP session • Windows 2019 - AWS
• Windows 2016 R2 - AWS
• Windows 2012 R2 - AWS
• Windows 10 AWS
• Windows 11 (Enterprise)
• Windows 10 Azure (Enterprise)
• Windows 10 VMWare (ESXi 6.7 and Horizon)
• Windows 10 Citrix
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SID# Scenario Supported OS

2 User has active RDP session • Windows 2019 - AWS
• Windows 2016 R2 - AWS
• Windows 2012 R2 - AWS
• Windows 10 AWS
• Windows 11 (Enterprise)
• Windows 10 Azure (Enterprise)
• Windows 10 VMWare (ESXi 6.7 and Horizon)
• Windows 10 Citrix

3 User's RDP session is
disconnected

• Windows 2019 - AWS
• Windows 2016 R2 - AWS
• Windows 2012 R2 - AWS
• Windows 10 AWS
• Windows 11 (Enterprise)
• Windows 10 Azure (Enterprise)
• Windows 10 VMWare (ESXi 6.7 and Horizon)
• Windows 10 Citrix

4 User's RDP session is locked • Windows 2019 - AWS
• Windows 2016 R2 - AWS
• Windows 2012 R2 - AWS
• Windows 10 AWS
• Windows 11 (Enterprise)
• Windows 10 Azure (Enterprise)
• Windows 10 VMWare (ESXi 6.7 and Horizon)
• Windows 10 Citrix

5 Another user has active
RDP session

• Windows 2019 - AWS
• Windows 2016 R2 - AWS
• Windows 2012 R2 - AWS
• Windows 10 AWS
• Windows 11 (Enterprise)
• Windows 10 Azure (Enterprise)
• Windows 10 VMWare (ESXi 6.7 and Horizon)
• Windows 10 Citrix

6 Another user has a
disconnected session

• Windows 2019 - AWS
• Windows 2016 R2 - AWS
• Windows 2012 R2 - AWS
• Windows 10 AWS
• Windows 11 (Enterprise)
• Windows 10 Azure (Enterprise)
• Windows 10 VMWare (ESXi 6.7 and Horizon)
• Windows 10 Citrix
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SID# Scenario Supported OS

7 Another user has an active
session and locked

• Windows 2019 - AWS
• Windows 2016 R2 - AWS
• Windows 2012 R2 - AWS
• Windows 10 AWS
• Windows 11 (Enterprise)
• Windows 10 Azure (Enterprise)
• Windows 10 VMWare (ESXi 6.7 and Horizon)
• Windows 10 Citrix

Additional notes on auto-login:
• Auto-login is only supported on 64-bit operating systems.
• Auto-login is unable to sign-out the root admin session, when trying with scenarios that involve two

different auto-login users. Remember to log out of the admin user account before deploying a бот.
• For scenarios 4, 5, and 6 in the above tables, the active user is logged off and a new session created

with device credentials for deploying the бот.

Понятия, связанные с данным
Manage device settings
Control Room administrator can configure the device settings to automatically set a user's default device
when that user logs into Control Room.
Задачи, связанные с данной
Configure auto-login settings
Configure auto-login settings in the Control Room to either create user sessions or reuse existing user
sessions to reduce the бот startup time.
Ссылки, связанные с данной
Совместимость Bot Agent
Перед установкой Bot Agent убедитесь, что он совместим с аппаратным и программным
обеспечением в вашем окружении.

Device requirements for Bot Agent
Review the Bot Agent device requirements such as hardware components, compatible devices, supported
operating systems and browser extensions.

Требования к аппаратному обеспечению

Вы можете установить Bot Agent на устройства, соответствующие указанным ниже требованиям к
оборудованию.
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Устройство Processor RAM Storage (free disk
space)

Network

Machine Intel Core i3 2.6
GHz with 4 multi-
cores or higher
64-bit

• 4 GB
(Minimum)

• 8 GB
(Recommended)

32 GB
Add 100 through
150 KB per
Automation
Anywhere script
Add 40 through 50
GB per long-term
project

• 5Mbps
(Minimum)

• 20Mbps
or higher
(Recommended)

Additional users
on a multi-user
device

2 CPU per
additional user

4 GB per
additional user

No additional
storage required

No additional
network needed

Additional RAM requirements for the
registered devices

Add additional RAM to account for applications
and services running on the registered devices, for
example:
• Microsoft Office applications (example: Excel)
• Browsers (example: Google Chrome)
• Enterprise applications (example: CRM, Oracle

EBS, and SAP)
• VDI infrastructure applications
• Anti-virus software
• AISense Recorder

Additional disk space on registered devices • Automation 360 scripts average approximately
100-150 KB. Additional free disk space is
required to develop automation projects because
temporary files such as screenshots, server logs,
and audit files are created during the execution
of the automation scripts.

• Free space required increases with the project
size. Recommendation: Have at least 40-50 GB
of free disk space for each long-term project.

• Increase storage space configuration after
installation, as needed, depending on product
usage. For example, depending upon the
complexity of your бот, generating log files and
logic creation require additional disk space later.

Совместимость устройств

Устройство, на котором запускается Bot Agent, для выполнения автоматизации должно отвечать
указанным ниже требованиям.

Прим.:
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• Требования к устройствам различаются для Control Room и Bot Agent.
Для получения информации о совместимости Control Room см. Операционная система, окружение
и платформа, поддерживаемые для Control Room

• Чтобы ваше устройство правильно работало в Amazon Workspaces, обновите реестр
на всех машинах рабочей области, переименовав файл spacedeskHookKmode.sys в
spacedeskHookKmode.sys.old в C:\Windows\System32\drivers. Перезагрузите компьютер
и убедитесь, что служба STXHD Hosted Application Service не запущена.
Подробнее см. в разделе Troubleshooting Amazon WorkSpaces issues.

Компьютеры On-Premises Физические компьютеры, работающие под
управлением поддерживаемых операционных
систем.

Серверы терминалов Удаленный рабочий стол (RDP), работающий на
поддерживаемых операционных системах версии
Enterprise A2019.11 или более поздних версий.

Виртуальные машины Начиная с версии Enterprise A2019.09 или более
поздней, Bot Agent можно установить на всех
виртуальных машинах (ВМ) с поддерживаемой
ОС Windows.
Чтобы средство записи AIsense работало на
виртуальной машине, включите инструкции AVX
для Bot Runner и Bot Creator.
Подробнее см. в разделе Automation 360: AI Sense
Recorder is crashing (A-People login required)

Bot Agent сертифицирован для всех основных
версий виртуальных машин и поддерживает
указанные ниже возможности.

Виртуальная машина
(ВМ)

Операционная
система и редакция

Amazon Web
Services EC2

• Windows 11
(Enterprise)

• Windows 10
(Professional)

• Windows 2012
Server,
Windows 2016
Server и
Windows 2019
Server (Standard и
Datacenter)

Amazon Web Services
WorkSpaces (пакет
Performance)

• Windows 11
(Enterprise)

• Windows 10
(Professional)
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Виртуальная машина
(ВМ)

Операционная
система и редакция

Google Compute
Engine

• Windows 11
(Enterprise)

• Windows 10
(Professional)

• Windows 2012
Server,
Windows 2016
Server и
Windows 2019
Server (Standard и
Datacenter)

Виртуальная машина
(ВМ) Microsoft Azure

• Windows 11
(Enterprise)

• Windows 10
(Professional и
Enterprise)

• Windows 2019
Server (Datacenter)

Виртуальный рабочий
стол Windows (WVD)
Microsoft Azure

• Windows 11
(Enterprise)

• Windows 10
(Enterprise)

Виртуальные машины
VMware на ESXi 6.x

• Windows 10
(Professional)

• Windows 2016
Server

Citrix XenDesktop (VDI) Windows 2016 Server

Citrix VM • Windows 10
(Enterprise)

• Windows 2016
(Server)

VMware Horizon Windows 10
(Enterprise)

Windows 365 Cloud PC Windows 11
(Enterprise)

Прим.:  При установке Bot Agent на
виртуальные машины, убедитесь, что вы
изменили настройки виртуальной машины
Power and Sleep (Питание и режим сна) на
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Never (Никогда), чтобы развертывания бот из
Control Room могли выполняться без перерыва.

Совместимость с операционной системой

Вы можете установить Bot Agent на компьютерах под управлением указанных ниже операционных
систем.
Эта совместимость относится к развертываниям On-Premises, Cloud и Community Edition в Automation
360.

Прим.:
• Поддерживается только 64-разрядная версия операционной системы.
• Задачи Bot Creator поддерживаются всеми перечисленными операционными системами.
• Bot Agent не может быть установлен на системах Linux. Вы не можете зарегистрировать

устройство, работающее под управлением Linux. Однако вы можете использовать
зарегистрированное устройство, работающее в системе Windows, для доступа к Control Room,
установленному в системе Linux.

Windows version Windows edition Bot Runner с
сопровождением

Bot Runner без
сопровождения

Bot Creator

Windows Server
2019

Datacenter and
Standard

Supported Supported1 Supported

Windows Server
2016

Datacenter and
Standard

Supported Supported1 Supported

Windows Server
2012

Datacenter and
Standard

Supported Supported1 Supported

Windows 11 Предприятие Supported Supported1 Supported

Windows 10 Professional and
Enterprise

Supported Supported1 Supported

Windows 8 2 Professional and
Enterprise

Supported Supported Supported

Windows 7 2 Professional and
Enterprise

Supported Supported Supported

(1) Auto-login • Auto-login is only supported on 64-bit systems.
• If the Auto-login fails, configure the Local

Security Policy settings. For example, in
Windows, select Security Settings > Local
Policies > Security Options. Enable the
Interactive logon > Do not require CTRL
+ALT+DEL option.

(2) Supported OS Windows 11 (64-bit) supported on Automation 360
Сборка 15459 or later.
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Windows 8 (64-bit) supported on Enterprise A2019
(Builds 1598 and 1610) or earlier.
Windows 7 (64-bit) supported on Enterprise
A2019.12 or later.

Совместимость с браузерами

Доступ к пользовательскому интерфейсу для Bot Agent осуществляется через браузер. Войдите
в Automation 360, используя поддерживаемые браузеры, чтобы установить и зарегистрировать
устройство.
Список поддерживаемых браузеров см. в разделе Поддерживаемые браузеры

Поддерживаемые расширения

Когда вы подключаете свое устройство Bot Agent к Control Room, можно включить поддерживаемые
расширения из браузера для записи автоматизации.
Список поддерживаемых расширений см. в разделе Расширения для автоматизации

Поддержка автоматического входа в систему

Функция автоматического входа используется для автоматического входа в устройство, запуска
запланированной автоматизации и восстановления исходного заблокированного или выключенного
состояния устройства после запуска автоматизации.
Сведения о поддержке операционной системы для автоматического входа в устройства Bot Agent см.
в разделе Auto-login support for Bot Agent

Working with Bot Agent
Users can perform tasks based on their assigned role after installing the Bot Agent on their device.
1. Review the prerequisites to install the Bot Agent are complete.

Совместимость Bot Agent

2. Install Bot Agent on your device.
• Установка Bot Agent и регистрация устройств
• Bulk install Bot Agent on devices

3. In order to deploy боты on your device, connect the Bot Agent to your device using an authentication
proxy and ensure that the changed proxy setting or credentials are updated.

Подключение Bot Agent к устройству с использованием прокси-сервера
4. Set device credentials to for the Control Room to deploy боты on your device.

Set user device credentials

5. Switch to a different Control Room based on your automation requirements.
Switch Bot Agent to a different Control Room
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6. When updates are available, you can update the Bot Agent to the latest version. You can enable one
of the following methods of updating Bot Agent:
• Автоматическое обновление Bot Agent
• Обновление Bot Agent вручную

7. Verify the Bot Agent version and device connection under the Devices page in Control Room.

Устройства

Related tasks

Users can also perform the following tasks:
• Use the Bot Agent diagnostic utility to perform diagnostic checks on Bot Runner devices and to help in

resolution of Bot Agent connectivity challenges.

Выполнение диагностических проверок Bot Agent
• Use the Bot Agent relevant logs to resolve issues.

Bot Agent log files
• Create and edit TaskBots

Создание первого бот | Редактирование бота
• Deploy боты on attended and unattended Bot Runner with or without Рабочая нагрузка automation.

Run a бот | Планирование бот | Запуск бот с очередью
• Manage different боты and пакеты using Bot Store, Bot Insight, and Automation 360 IQ Bot.

• Bot Store
• Использование Bot Insight
• Automation 360 IQ Bot

• Perform other activities such as updating user profile.

Редактировать профиль

Прим.:  For additional information about the Bot Agent, see Automation Anywhere Certification (A-People
login required)

Bot Agent communication with Control Room
Bot Agent uses various channels to communicate with the Control Room. Relevant data is transferred
directly and indirectly using communication channels such as loop-back interface, browser plug-in, and
WebSocket connection.
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Browser to loop-back interface

The browser-to-loop-back-interface channel is used during initial Bot Agent device registration and post-
registration to check the current connection status to the Control Room. The loop-back interface uses HTTP
unencrypted connection.
The following initial registration data is transferred over this channel:
• Control Room user token. This is accessible through developer tools on the browser.
• URL-адрес Control Room
• Proxy metadata, such as device ID, whether the proxy is configured or not, and whether it uses

authentication or not.

The following connection status data is transferred over this channel:
• ID устройства
• URL-адрес Control Room
• Installation type, such as system-level or user-level
• Proxy metadata, such as device ID, whether the proxy is configured or not, and whether it uses

authentication or not.

Browser to Control Room

The browser-to-Control Room channel is used by the browser to connect to the Control Room. The data
transferred over this channel includes all Control Room web data. The browser uses HTTPS encrypted
connection.

Plug-in to Bot Agent named pipe

The plug-in to the Bot Agent named pipe channel is used to fetch current logged-in username and
credentials if an authenticated proxy is to be obtained for the browser. The plug-in channel is protected by
user permissions.

Bot Agent to Control Room WebSocket

The Bot Agent-to-Control Room WebSocket channel is used for all command and data transfer between the
Bot Agent and Control Room. Data transferred over this channel includes requests from the Bot Agent to
the Control Room, бот code transfer, password data, Control Room-to-Bot Agent requests. Password data
is payload-encrypted, with the device public key in addition to the TLS encryption of the channel.

Установка Bot Agent и регистрация устройств
Install Bot Agent on your local device and connect it to Control Room. In order to run боты on that local
device, ensure that you add it to the list of enabled host devices.
• To install the Bot Agent, the Windows installer policy must be enabled for your local device.
• The read, write, and execute permissions must be enabled for the Bot Agent folders on your local

device.
• Ensure that the local device system date and time are in sync with the current date and time so that

the device registration is successful.
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Credential requirements

Версия Bot Agent, доступная для загрузки, является последней и совместимой с используемой
версией Control Room.

Прим.:
• You can now install the Bot Agent on a device with an existing Enterprise 11 client.

• A Bot Creator can log in and access both Automation 360 and Enterprise 11 client to create боты.
• Attended Bot Runner can run боты from both Automation 360 and Enterprise 11 Control Room

instances.
• Unattended Bot Runner can deploy боты by using the run and schedule permission on the same

device.

• Невозможно запускать боты из Enterprise 11 и Automation 360 одновременно.
• You cannot install a Bot Agent on a device with an existing Enterprise 10 client.
• When the Bot Agent is installed on a device where Enterprise 11 client is also installed and then you

uninstall the client, you might face login issues with the device. Therefore, you must uninstall and re-
install the Bot Agent on the device.

1. Use a supported browser to log into Control Room through your Automation Anywhere URL.
2. Установите Bot Agent и добавьте локальное устройство, выбрав один из указанных ниже

параметров.
• From the menu on the left, click the device icon to connect a local device.
• Перейдите на страницу Устройства и щелкните кнопку Подключить локальное

устройство в правом верхнем углу списка устройств.

3. Щелкните Подключиться к моему компьютеру.
Загружается файл установки Bot Agent.

4. Выполните шаги, описанные в мастере.
Доступ через прокси-сервер с аутентификацией. Если доступ вашего устройства к
Интернету осуществляется через прокси-сервер с аутентификацией, вам будет предложено
предоставить данные аутентификации для прокси-сервера. Эти учетные данные необходимы
для того, чтобы устройство могло взаимодействовать с Control Room.
Для доступа через прокси-сервер с аутентификацией зарегистрируйте устройство с помощью
браузера Google Chrome с включенным расширением Chrome Automation 360.

Прим.:  The Chrome and Edge extensions are installed for Google Chrome and Microsoft Edge
Enterprise browser users, respectively, even if the device is offline. The extension is downloaded with
the Bot Agent MSI installer file.

5. Выберите вариант установки Bot Agent — на уровне системы или на уровне пользователя.
• Для установки на уровне системы выберите вариант Для любого пользователя этого

компьютера (все пользователи)
Этот Bot Agent могут использовать все пользователи устройства. Однако пользователи,
устанавливающие Bot Agent, должны иметь права администратора.

• Для установки на уровне пользователя выберите Only for me (username) (Только для меня
(имя пользователя)).
Bot Agent будет доступен только отдельному пользователю.
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6. На экране Дополнительная информация введите указанные ниже данные.
• Псевдоним устройства (необязательно)
• Тип устройства (один пользователь или несколько пользователей)

Прим.:  Для устройства с несколькими пользователями введите количество одновременных
сеансов, которые будут разрешены. Поддерживается не менее двух параллельных сеансов.

7. Щелкните Выполнено.
• Bot Agent устанавливается в папку по умолчанию C:\Program Files\Automation

 Anywhere\Bot Agent.
• The Bot Agent is registered as a Windows service: Automation Anywhere Bot Agent Service.
• Ярлык для доступа AARI Assistant добавляется в меню «Пуск» и на рабочий стол Windows.
• Файлы Java Runtime Environment (JRE) устанавливаются с Bot Agent в папке установки Bot

Agent: C:\Program Files\Automation Anywhere\Bot Agent\jre.

8. Установите учетные данные устройства пользователя, чтобы устройство могло запускать боты.
9. Обновите страницу Устройства и убедитесь, что локальное устройство добавлено.

Вы можете идентифицировать устройства по IP-адресу и имени хоста.

Прим.:  После удаления устройства подождите 35 секунд, чтобы повторно зарегистрировать
его.

Поиск и устранение неисправностей:
• При возникновении проблем с регистрацией устройства см. раздел Automation 360: Error while

registering device - An unexpected problem occurred (A-People login required).
• If the Bot Agent service is paused and does not start after installation, see Automation 360 Error: Device

is disconnected or needs upgrade (A-People login required).
• При использовании браузера Google Chrome версии 94 или более поздней, если у вас возникли

проблемы с регистрацией устройства в Control Room On-Premises, рекомендуется настроить
Control Room на использование HTTPS вместо HTTP. В качестве альтернативы используйте
Microsoft Internet Explorer или Mozilla Firefox для регистрации своего устройства.
If you face any issues adding a new device, see Unable to Add New Device (A-people login required).

• Если вручную удалить расширение Google Chrome, существующая политика Google Chrome
не позволит вам добавить расширение (онлайн или в автономном режиме) даже после
переустановки Bot Agent. Мы рекомендуем не удалять расширение. Если вы все же вручную
удаляете расширение, выполните одно из указанных ниже действий.
• Перейдите в магазин расширений Google Chrome, чтобы добавить расширение в режиме

онлайн.
Automation 360 extension for Chrome

• Перетащите файл ChromeExtension.crx (C:\Program Files\Automation Anywhere
\Bot Agent\AABrowserAgent) на вкладку расширения Google Chrome (меню
«вертикальное многоточие» в правом верхнем углу > Настройки > Расширения).

Посмотрите указанное ниже видео о том, как установить Bot Agent в Automation 360.

Необязательно: Редактировать профиль.
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If your device is set with a proxy, see the tasks that apply to your proxy settings, Подключение Bot Agent к
устройству с использованием прокси-сервера.
Понятия, связанные с данным
About device pools
Device pools are a logical grouping of devices or similar unattended Bot Runner machines on which you
can run your workload management automations or scheduled unattended automations. For example, you
can group the devices (system-wide type) of a specific department or unit and create a device pool.
Задачи, связанные с данной
Create device pools
Create a device pool with a unique name and add Unattended Bot Runner to the device pool.
Set user device credentials
To enable a device for running боты, set the local device credentials.

Автоматическое обновление Bot Agent
Администратор Control Room может выбрать автоматическое обновление Bot Agent до более поздней
версии с помощью функции автоматического обновления. Это сокращает время простоя, так как
каждому пользователю не нужно входить в Control Room для обновления Bot Agent, установленного
на устройстве пользователя.
Ensure that you are logged in to the  as the administrator.
Bot Agent будет автоматически обновляться в случае соответствия указанным ниже условиям.
• Все устройства пользователей подключены к Control Room.
• Развертывание Automation 360, которое вы используете.

Прим.:  Automatic update of the Bot Agent is available only for version 21.0 or later. Настройка
автоматического обновления включена по умолчанию для Cloud Automation 360 и Community
Edition. Для развертываний On-Premises параметр ручного обновления настроек включен по
умолчанию.

To manually update Bot Agent, see Обновление Bot Agent вручную.
1. Перейдите в раздел Администрирование > Настройки > Устройства.
2. Выберите настройки ПО бот-агента.
3. Click the Edit icon. ( )
4. For automatic updates of the Bot Agent, you can choose either all updates (required and optional) or

only the required updates.
Вариант Описание

Auto update optional and mandatory Automatically update the Bot Agent for both
required and optional updates.
During the update, new бот deployments on the
Bot Runner user devices are queued.

Auto update mandatory updates only Automatically update the Bot Agent only for
required updates.
During the update, new бот deployments on the
Bot Runner user devices are queued.

Прим.:  To set manually update the Bot Agent, choose Disable auto updates option.
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5. Необязательно: Update the Bot Agent from a local drive.
6. Щелкните Сохранить изменения.

Проверьте версию Bot Agent и подключение устройства на странице Мои устройства в Control
Room.
Задачи, связанные с данной
Обновление Bot Agent вручную
The Bot Agent is a lightweight application with which you can run боты on your device. You can update
the Bot Agent when a new version becomes available.
Ссылки, связанные с данной
Устройства
Устройство — это компьютер, с которого пользователь подключается к Control Room, чтобы
создавать или запускать боты. Manage devices that are registered to the Control Room through the
Devices page located in the Manage tab.
Совместимость Bot Agent
Перед установкой Bot Agent убедитесь, что он совместим с аппаратным и программным
обеспечением в вашем окружении.

Update the Bot Agent from a local drive
As a Control Room administrator, you can download the Bot Agent installation file to a local machine and
update the Bot Agent from the local drive.
Ensure that the Bot Agent installation file is downloaded to the local machine.

Важное замечание:  This functionality is implemented in v.26 and can be used from v.27. That is, after
you update your Bot Agent to v.26, future updates can be performed from the local drive.

Update the Bot Agent on several devices by providing the local file path to the installation file.
1. Navigate to Administration > Settings > Devices and click the Edit icon ( ).
2. Go to the Bot-agent software settings.
3. Click the Edit icon. ( )
4. In the Bot agent installation section, select the Update bot agent from local drive option.

When the Update bot agent from local drive option is enabled, the device checks for the
installation file in the local drive and use it to update the Bot Agent.

Прим.:  If an installation file is not available in the local drive or not compatible with Control Room,
the Bot Agent will be updated with the latest version from the Control Room.

5. Enter the file path to the Bot Agent installation file in your local drive.
Пример. C:\Temp\AutomationAnywhereBotAgent.exe or \\network-share-name
\foldername1\AutomationAnywhereBotAgent.exe

6. Щелкните Сохранить изменения.

Обновление Bot Agent вручную
The Bot Agent is a lightweight application with which you can run боты on your device. You can update
the Bot Agent when a new version becomes available.
• Для установки Bot Agent должна быть включена политика установщика Windows для устройства

пользователя.
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• Должны быть включены разрешения на чтение, запись и выполнение для папок Bot Agent на
устройстве пользователя.

Версия Bot Agent, доступная для загрузки, является последней и совместимой с используемой
версией Control Room. См. раздел Совместимость Bot Agent.

Прим.:  Можно выполнить обновление до последней версии Bot Agent, чтобы использовать новые
функции, доступные в последнем выпуске Automation 360. However, some Bot Agent versions are
optional to update and does not affect your existing боты. См. раздел Совместимость Bot Agent.

• Update the Bot Agent on connected host devices
a) Log in to the Control Room by using your Automation Anywhere URL.
b) Navigate to Manage > Devices.

На странице Устройства статус устройства показывает, требуется ли обновить Bot Agent.
Цвет стрелки на значке устройства указывает на статус:
• Red: Update required
• Blue: Update available but not required
• Green: Current version; no update required

c) To update the Bot Agent on devices, select the devices for which you want the Bot Agent to be
updated and, at the top-right corner of the devices table, click the Update checked items icon
( ).
The Status for the devices changes to indicate the progress of the update. After the update is
complete, the Status will be changed to Connected.

Прим.:  Можно также обновить одно устройство с помощью низкоуровневых действий.

Video: See the following video on updating the Bot Agent on connected host devices:

• Update the Bot Agent on a locally connected device or a remote device using the local
device option
You can update the Bot Agent on a locally connected device or a remote device without manually
downloading and installing the Bot Agent.
a) On the home screen, at the bottom-left corner, click the Local device icon ( ).
b) In the Bot running device window, click Update now.

The Status for the devices changes to indicate the progress of the update. After the update is
complete, the Status changes to Connected.

Video: See the following video on how to update the Bot Agent on a locally connected device:

Video: See the following video on how to update the Bot Agent on a remote device using the local
device option:
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• Update Bot Agent on the locally connected device using the connect local device option
You can update the Bot Agent on your locally connected device by manually downloading and installing
the Bot Agent.
a) From the Devices page, click the Connect local device icon ( ) at the top-right corner of the

devices table.
b) Щелкните Подключиться к моему компьютеру.
c) Щелкните ссылку Загрузить последнюю версию вручную.
d) After the AutomationAnywhereBotAgent.exe is downloaded, install the Bot Agent and follow

the instructions on the installation wizard to complete the installation.
e) After the Bot Agent installation is complete, go back to Automation 360 Control Room and click

Next.
f) Follow the instructions on the screen to complete the update.

Video: See the following video on how to update the Bot Agent on the locally connected device using
the connect local device option:

Отобразится указанное ниже сообщение. Подключено к вашему компьютеру. Локальный
бот-агент установлен и настроен.

Если на экране отображается сообщение Устройство отключено или должно быть
обновлено!, см. Error: Device is disconnected or needs upgrade (A-People login required)

Проверьте версию Bot Agent и подключение устройства на странице Устройства в Control Room.
Задачи, связанные с данной
Автоматическое обновление Bot Agent
Администратор Control Room может выбрать автоматическое обновление Bot Agent до более поздней
версии с помощью функции автоматического обновления. Это сокращает время простоя, так как
каждому пользователю не нужно входить в Control Room для обновления Bot Agent, установленного
на устройстве пользователя.
Ссылки, связанные с данной
Устройства
Устройство — это компьютер, с которого пользователь подключается к Control Room, чтобы
создавать или запускать боты. Manage devices that are registered to the Control Room through the
Devices page located in the Manage tab.
Совместимость Bot Agent
Перед установкой Bot Agent убедитесь, что он совместим с аппаратным и программным
обеспечением в вашем окружении.

Switch Bot Agent to a different Control Room
Switch the Bot Agent on a registered device to work with a different Control Room manually when you
work on automations using different environments.
Ensure that you have the start, stop, and pause permissions to access and edit the Windows services.
Perform this task to manually associate your device with a different Control Room in the following
scenarios:
• When the Control Room is on a different release version.
• When the setting to switch devices is not enabled in the Control Room.

1. Stop the Bot Agent service from the local Windows Task Manager.
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2. Navigate to the following folder: C:\Windows\System32\config\systemprofile\AppData
\Local\AutomationAnywhere

3. Необязательно: Delete the registration.properties file.

Прим.:  This is only required if you want to register the device in a different Control
Room environment. To view the Control Room where the device is registered, open the
Registration.properties file and check the value for the Control Room URL.

4. Delete all .db files.
For example, AA-DB.mv.db file.

5. Войдите в Control Room.
6. Navigate to Devices > My devices.
7. Click the Add local device icon.
8. Download and install the latest Bot Agent.
9. Return to the Devices page in the Control Room from the updated device to check the device status.

The registration.properties file is not generated immediately after the Bot Agent
installation. It is generated only when a user accesses a Control Room URL from that
device. If the device registration is successful, the machine is shown as Connected and the
registration.properties file is created at the specified location on the Bot Runner machine.

10. Navigate to the C:\Windows\System32\config\systemprofile\AppData\Local
\AutomationAnywhere folder to ensure that the registration.properties file is present and
verify the Bot Agent update.

Задачи, связанные с данной
Установка Bot Agent и регистрация устройств
Install Bot Agent on your local device and connect it to Control Room. In order to run боты on that local
device, ensure that you add it to the list of enabled host devices.
Переключение регистрации устройства между экземплярами Control Room
Настройте параметры устройства в Control Room, чтобы позволить однопользовательским
устройствам легко переключаться между разными экземплярами Control Room для запуска боты в
нескольких окружениях. Этот параметр позволяет вам зарегистрировать Bot Agent на нескольких
экземплярах Control Room без удаления Bot Agent.

Подключение Bot Agent к устройству с использованием прокси-сервера
Когда вы устанавливаете Bot Agent, настройки прокси-сервера вашего устройства импортируются
в процессе установки. Однако если параметры прокси-сервера не были импортированы во время
установки, вы можете обновить сведения о конфигурации прокси-сервера вручную.

Прим.:  Your device proxy settings for authenticated proxy can be set during the Bot Agent registration
process and can be updated via the Bot Agent diagnostic utility. The same credentials will be used for all
users on the device.

Обычно, когда вы изменяете настройки прокси-сервера, добавляете ли вы прокси-сервера или
изменяете учетные данные для прокси-сервера с аутентификацией, Bot Agent запрашивает новые
учетные данные.
Для добавления или обновления учетных данных прокси-сервера вручную можно использовать два
метода.
• Using PSExec -sid command.
• Using netsh winhttp command.
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Эти действия можно выполнить до или после установки Bot Agent.
1. Для добавления или обновления учетных данных прокси-сервера используйте любой из

указанных ниже методов.
• Using PSExec -sid command.

a. Загрузите PSTools.
PsExec

b. Извлеките файлы из загруженного zip-файла.
c. Откройте командную строку Microsoft в режиме администратора.
d. Перейдите в каталог, в который вы извлекли файлы PSTools.
e. Выполните следующую команду:

.\psexec -i -s -d cmd

f. В новом окне командной строки выполните следующую команду:

whoami

The system returns the following:

nt authority\system

g. Выполните следующую команду:

inetcpl.cpl

h. В Свойствах Интернета перейдите в раздел Подключения > Настройки LAN.
i. Выберите параметр Использовать сценарий автоматической настройки.
j. Укажите адрес файла автоматической настройки прокси-сервера (Proxy Auto-

Configuration; PAC).
Пример. http://localhost:888/proxy.pac.

k. Щелкните OK.

• Using netsh winhttp command.
a. Откройте командную строку Microsoft в режиме администратора.
b. Отобразите статус прокси-сервера, выполнив следующую команду:

netsh winhttp show proxy

c. If the command returns Direct access, then run the command:
netsh winhttp import proxy source = ie

Если параметры прокси-сервера настроены, команда возвращает адрес прокси-сервера.
См. приведенный ниже пример.

Current WinHTTP proxy settings:
Proxy server(s): 123.0.0.4:1234
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Bypass List    : (none)

You do not have to import the settings.

Прим.:  We recommend you import proxy settings using Bot Agent installer because of limitations
to importing PAC file using the netsh winhttp import proxy source = ie command.

2. Перезапустите службу Bot Agent из служб Windows.
3. Откройте браузер Google Chrome с включенным расширением Automation Anywhere.
4. Выйдите из системы Control Room и снова войдите в нее.

Если появится запрос, укажите учетные данные прокси-сервера.
5. В Control Room проверьте статус устройства и убедитесь, что оно подключено.

Ссылки, связанные с данной
Automation 360 Bot Runner device requirements
Review the machine hardware specifications, operating system versions, and browser types supported
for creating and running боты on a device. The same requirements are also valid for Automation 360
Community Edition.
Совместимость Bot Agent
Перед установкой Bot Agent убедитесь, что он совместим с аппаратным и программным
обеспечением в вашем окружении.
Add Automation 360 Cloud URLs to trusted list
To ensure secure access to Automation 360 cloud services, add the URL specific to the service to the safe
recipients or trusted list.
Add Automation 360 On-Premises URLs to trusted list
To ensure secure access to Automation 360 online services for On-Premises deployment, add the URL
specific to the service to the safe recipients or trusted list.

Выполнение диагностических проверок Bot Agent
Используйте утилиту диагностики Bot Agent для решения проблем, связанных с подключением
между устройством Bot Runner и Control Room. Утилита помогает диагностировать проблемы,
предоставляя решения или предложения по их устранению.
Убедитесь, что Bot Agent установлен на устройстве пользователя.
1. Откройте командную строку Windows.
2. Перейдите по пути установки Bot Agent.

• Путь по умолчанию для Bot Agent, установленного на уровне системы: C:\Program Files
\Automation Anywhere\Bot Agent.

• Путь по умолчанию для Bot Agent, установленного на уровне локального пользователя:
%USERPROFILE%\AppData\Local\Programs\Automation Anywhere\Bot Agent.
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3. Введите AADiagnosticUtility.exe, чтобы запустить утилиту диагностики Bot Agent.
Отобразятся различные варианты выполнения диагностической проверки и их описание.

Вариант Описание

-checkDownloadError <CR_URL> Проверка на наличие ошибок загрузки
зависимостей бот в случае сбоя
развертывания бот.

Прим.:  Сообщения об ошибках сохраняются
в памяти устройства и удаляются при
перезапуске службы Bot Agent.

Используйте этот параметр, когда устройство
Bot Runner подключено к Control Room, но
при автоматизации происходит сбой, потому
что зависимые пакеты не загружаются на
устройство Bot Runner. В этом случае утилита
предоставляет предложения по дальнейшей
диагностике.

-checkProxy <CR_URL> Проверка настроек прокси-сервера на
устройстве.
Когда устройство Bot Runner не может
подключиться к Control Room, используйте
этот параметр, чтобы проверить, доступен
ли прокси-сервер и настроен ли он для
использования Bot Agent.
You are also provided the option to import proxy
settings using the importProxy option.

Прим.:  Your device proxy settings for
authenticated proxy can be set during the Bot
Agent registration process and can be updated
through the Bot Agent diagnostic utility. The
same credentials are used for all users on the
device.

-checkWSError <CR_URL> Проверка на наличие ошибок и проверка
подключения к WebSocket.

Прим.:  Сообщения об ошибках сохраняются
в памяти устройства и удаляются при
перезапуске службы Bot Agent на вкладке
«Службы» диспетчера задач Windows.

Когда устройство Bot Runner не может
подключиться к Control Room из-за ошибок
подключения WebSocket, с помощью этого
параметра можно установить возможные
причины для дальнейшего изучения.
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Вариант Описание

-collectLogs Сокращение времени сбора информации
о проблемах путем записи нескольких
журналов для устройства Bot Runner.
Используйте этот параметр для сбора и
сохранения актуальных журналов менеджера
узлов, программы запуска бот и средства
просмотра событий для отладки и устранения
неполадок в заархивированной папке на
устройстве, на котором запущена утилита.
• Для Bot Agent, установленного на уровне

системы, журналы сохраняются в папке C:
\ProgramData\AutomationAnywhere
\BotRunner\Logs
\bot_agent_logs_<datetimestamp>.zip

• Для Bot Agent, установленного на уровне
локального пользователя, журналы
сохраняются в папке %USERPROFILE%
\AppData\Local\AutomationAnywhere
\BotRunner\Logs
\bot_agent_logs_<datetimestamp>.zip

Прим.:
• Для сбора журналов Windows для событий

безопасности, запустите утилиту с
повышенными полномочиями (от имени
администратора).
Если запустить утилиту без повышенных
полномочий, появится следующая ошибка.
Ошибка. Невозможно сохранить файл
 security_event_viewer_<дата>.evtx

• Чтобы сэкономить место в хранилище,
удалите файл после отладки.

-configProxy <CR_URL> Проверка конфигурации прокси-сервера и
настройка учетных данных прокси-сервера
при необходимости.
Когда устройство Bot Runner не может
подключиться к Control Room из-за отсутствия
учетных данных для аутентифицированного
сервера, используйте этот параметр для
настройки учетных данных прокси-сервера.
Убедитесь, что проблема с подключением
решена, войдя в Control Room.
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Вариант Описание

-importProxy <CR_URL> Импорт настроек прокси-сервера с устройства
пользователя, вошедшего в систему, на
устройство пользователя системы.

Прим.:  Для импорта настроек
прокси-сервера необходимо иметь
разрешения администратора.

Когда устройство Bot Runner не может
подключиться к Control Room из-за проблем с
прокси-сервером, используйте этот параметр
для импорта настроек прокси-сервера
из вошедшего в систему пользователя в
системного пользователя для Bot Agent.
Этот параметр предоставляет указанную
ниже информацию.
• Является ли прокси-сервер

аутентифицированным или нет.
• URL-адрес Control Room добавляется

в список безопасных получателей на
прокси-сервере.

• Подключения WebSocket разрешены как
часть конфигурации прокси-сервера.

-importSSLCertificate
 path_to_ssl_certificate

Импорт сертификата SSL в хранилище
учетных данных Java при необходимости.

Прим.:  Для импорта сертификата
SSL необходимо иметь разрешение
администратора.

Когда устройство Bot Runner не может
подключиться к Control Room из-за
недействительного сертификата
SSL, используйте этот параметр для
импорта сертификата SSL. You must
ensure a valid certificate file is available
in the file location specified in the
importSSLCertificatepath_to_ssl_certificate
option.
Чтобы импортированный сертификат начал
действовать, необходимо перезапустить Bot
Agent Automation Anywhere.

-list Просмотр активных развертываний бот на
локальных устройствах.
Используйте этот параметр, чтобы
проверить и составить список запущенных
автоматизаций (боты).
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Вариант Описание

-ping <CR_URL> Проверка соединения между Control Room и
устройствами Bot Runner.
Используйте этот параметр, чтобы проверить,
может ли устройство Bot Runner выполнять
запросы ping (достигать) Control Room.

-validateSSLCertificate
 <CR_URL>

Проверка наличия действующего
сертификата SSL и того, является ли
сертификат действительным.

Прим.:  Для выполнения этой проверки у вас
должно быть разрешение на чтение.

Когда устройство Bot Runner не может
подключиться к Control Room из-за
недействительного сертификата SSL,
используйте этот параметр для проверки
того, действителен ли сертификат
SSL. To resolve the issue, use the
importSSLCertificate option.

4. Введите в командной строке следующий параметр: <путь к файлу>
\AADiagnosticUtility.exe -<параметр> <CR_URL>
Например, чтобы проверить ошибки WebSocket, введите в командной строке следующее:
AADiagnosticUtility.exe -checkWSError https://yourcrurl.com/
Параметр возвращает указанный ниже результат. В последнее время это устройство не
сталкивалось с ошибками Web Socket

Для выполнения дальнейших диагностических проверок используйте другие параметры.

Set user device credentials
To enable a device for running боты, set the local device credentials.
The Bot Agent is a lightweight application that enables you to run боты on your device by connecting
the device to the Control Room. To run боты on a local machine, install the Bot Agent and add the local
device to the list of enabled host devices. Add the local device before editing the credentials. См. раздел
Установка Bot Agent и регистрация устройств.
For Community Edition users, your profile contains only one set of credentials at a time. These credentials
are applied to any of your registered devices you select to run your боты. Убедитесь, что каждое
используемое вами устройство принимает учетные данные в вашем профиле.
Automation 360 Cloud users have the option to apply different credentials to registered devices.
1. In the Control Room panel, click your user name and select My settings.
2. In My Settings page, navigate to Devices > Credentials section to update the Username and

Password for the device.
Device login credentials are required to run a бот from this device.

Прим.:  Automation 360 does not validate the device login credentials until you run a бот.

If your username is part of a domain, include the domain within the format domain\username.
Typically, home users are not part of a domain, unless they are specifically configured.
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3. Сохраните изменения.

Создание первого бот
Задачи, связанные с данной
Установка Bot Agent и регистрация устройств
Install Bot Agent on your local device and connect it to Control Room. In order to run боты on that local
device, ensure that you add it to the list of enabled host devices.

View and update Bot Agent device settings
View your local device details and update the бот running device settings. The local device is the one from
which you access the Bot Agent. The бот running device is the one on which the recorder will record your
automations and run the боты.
You must have the register device, view and manage all devices, attest device credentials, and edit devices
permissions to perform this task. См. раздел Credential requirements.
This task is performed by a user to select a local user or remote Bot Agent device to create and run боты.
1. In the Control Room, click your username and select the My settings link.
2. In the Devices > Bot running device section, click Edit.
3. Select a бот running device.
4. Сохраните изменения.

Прим.:  To update the local device settings, click the device name link. This will open the Devices
page for your local device in view mode.

Понятия, связанные с данным
Manage device settings
Control Room administrator can configure the device settings to automatically set a user's default device
when that user logs into Control Room.

Bulk install Bot Agent on devices
Installing Bot Agent across multiple devices such as on-premises machines, virtual machines (VM), and
non-persistent virtual desktop infrastructure (VDI) is called Bulk install (or silent install). You must edit the
Bot Agent MSI file for bulk installation.
To perform the task, you must have a  administrator account with the required rights and permissions.
• Ensure that you have downloaded the MSI file from the Control Room and the parameters required to

install devices are available in the Bot Agent MSI file.

Прим.:  If you are trying to download the MSI file for the first time, you must click Settings > Bot
agent bulk install > Edit > Save changes to generate a registration key and view the Download
installer for the MSI file. .

• Ensure that the Windows 10 Software Development Kit including Orca is installed on the device.
Установить Orca можно из файла C:\Program Files (x86)\Windows Kits\10\bin
\10.0.18362.0\x86\Orca-x86_en-us.msi.
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Прим.:  You can find a sample autoregistration.properties file at the end of the page for your
reference.

1. Используйте последнюю версию файла AutomationAnywhereBotAgent.msi из указанных
ниже местоположений.
• Загрузите файл из Control Room (Администратор > Настройки > Массовая установка

бот-агента).
Возможность загрузки доступна для развертываний On-Premises и Cloud.

• Выберите файл из папки <путь к файлу приложения>\crui\asset. Например, C:
\Program Files\Automation Anywhere\crui\asset

Эта возможность доступна только для развертываний On-Premises.

2. Отредактируйте файл AutomationAnywhereBotAgent.msi, используя инструмент Orca.
3. Выберите параметр Свойство.
4. Введите соответствующие значения для указанных ниже параметров.

Параметр Описание

AA_CRURL Введите экземпляр Control Room, к
которому будет подключен Bot Agent.

Прим.:  Не добавляйте обратную
косую черту (/) в конце URL-адреса
Control Room. Например,
mycr.mydomain.com/, .

AA_CRTOKEN Введите соответствующее значение
регистрационного ключа для всех
Control Room. Регистрационный ключ
предоставляется администратором Control
Room.
Можно настроить до 20 URL-адресов
Control Room. Ensure that:
• You provide the corresponding

registration tokens under AA_CRTOKEN,
AA_CRTOKEN2 through AA_CRTOKEN20
for each configured Control Room URL.

• There is a one-to-one match between
CR_URL and CR_TOKEN.

• There is no skipping between CR_URL
and CR_TOKEN, and this is filled
consecutively.
Например, чтобы настроить три
URL-адреса Control Room, их нужно
заполнить в следующем порядке:
AA_CRURL, AA_CRURL2, AA_CRURL3.

См. раздел Generate registration key to install
Bot Agent in bulk.
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Параметр Описание

AA_DELAY_REGISTRATION_UNTIL_LOGIN Enter True to delay the Bot Agent
registration to a Control Room until a user
logs in to that Control Room.
Если пользователь входит в любой из
экземпляров Control Room, настроенных
с устройства, на котором установлен Bot
Agent, то Bot Agent на этом устройстве
будет автоматически зарегистрирован со
связанной Control Room. If the logged-in
Control Room URL is not configured, then
Bot Agent is not registered with that Control
Room.

AA_DEVICE_TYPE Введите одно из указанных ниже
значений для типа устройства.
• SINGLE_USER
• MULTIPLE_USERS

Прим.:  Ensure that you enter the values in
uppercase.

AA_LIFESPAN Введите одно из указанных ниже
значений для непостоянного или
постоянного устройства.
• TEMPORARY
• PERSISTENT

Прим.:  Ensure that you enter the values in
uppercase when you install the Bot Agent.

AA_CONCURRENT_SESSIONS Введите допустимое количество
одновременных сеансов, от 1 до 99.
Значение по умолчанию: 1.

Прим.:  The concurrent sessions are
only applicable for multi-user devices
(AA_DEVICE_TYPE = Multiuser)
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Параметр Описание

AA_INSTALL_ONLY Выберите, хотите ли вы установить Bot
Agent без регистрации с использованием
Control Room.
• Чтобы только установить, но не

регистрировать Bot Agent, введите
True.

Прим.:
The autoregistration.properties
file is created when AA_INSTALL_ONLY
is set to True. You can set
AA_INSTALL_ONLY to True only for
system-level installation.

• Чтобы установить Bot Agent и
зарегистрировать его, введите False.

AA_DEVICE_POOL_NAME Specify the device pool name. Значение по
умолчанию: 0.

Прим.:  Ensure that you use an existing
device pool.

5. Сохраните изменения.
6. Скопируйте файл AutomationAnywhereBotAgent.msi в экземпляр виртуальной машины

(эталонный образ), на который вы хотите установить Bot Agent.
7. Запустите файл AutomationAnywhereBotAgent.msi.
8. Проверьте, что Bot Agent установлен на экземпляре виртуальной машины, а служба Bot Agent на

вкладке «Службы диспетчера задач» не запущена.

Прим.:  An autoregistration.properties file will be generated at C:\Windows
\System32\config\systemprofile\AppData\Local\AutomationAnywhere.

Для развертывания Bot Agent на временных или непостоянных устройствах необходимо задать
настройки SysPrep и создать образы машин на экземпляре виртуальной машины.
9. После включения настроек имени временного или непостоянного компьютера для ВМ

выключите экземпляр ВМ без SysPrep.
Пример использования SysPrep на экземпляре EC2 AWS см. в разделе Use Sysprep to create and
install custom reusable Windows AMIs.

10. При необходимости создайте образы машин на экземпляре ВМ.
Пример создания образов машин Amazon (Amazon Machine Images; AMI) из экземпляра EC2 AWS
см. в разделе Create an AMI from an Amazon EC2 Instance.

Если Bot Agent зарегистрирован в экземпляре виртуальной машины по ошибке, выполните
указанные ниже действия для восстановления образа машины.
1. Удалите Bot Agent с панели управления Windows экземпляра виртуальной машины.
2. Удалите все файлы из папки C:\Windows\System32\config\systemprofile\AppData

\Local\AutomationAnywhere.
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3. Enter True for the AA_INSTALL_ONLY parameter in the AutomationAnywhereBotAgent.msi file
that you previously used to install the Bot Agent.

Sample autoregistration.properties file

url=http://ec2-myexampleCR.com
url2=URL2
url3=URL3
url4=URL4
token=eyJhbGciOiJSUzUxMiJ9.eyJjbGllbnRUeXBlIjoiQk9UX0FHRU5UX0FVVE9fUkVHSVNUUkFUSU9OIiwidGVuYW50VXVpZCI6ImI4ZjVmNDE0LWMzZDMtNGRhNy04NDljLWMxOGUwOGNiM2Q5ZCIsImlhdCI6MTY1NTg3NTgyMiwiZXhwIjoxOTcxMjM1ODIyLCJpc3MiOiJBdXRvbWF0aW9uQW55d2hlcmUiLCJuYW5vVGltZSI6NzMxMDYzMzkwNzQ5NX0.BA2bPiIECl9PE34BC1mj2iePLuTlSd8y8Fe1LtIkOKYrD8mR-
KVOnMeupDQF4IQ3oZbjpyk73vrLI2k0UeTVpvKuURbZhz8bPIBYer4zlzRjEB-9nOID8MtNRcpzlXgkQ27GEN2pOn4Xs_k198rPJEYHcTwaHRbQ8Mv5UF0eGd8_Q9sLgZB6jt1BhnzMNS3qwZBl1aG1xbOc7orlfyBfTGSvAxnlsRa3_fF7QeFKiw7EdfJDGsIVmIZ58-
IMzer-R8sxMnr7hSfi_aYDx8emyoH2XtFAQAYuXiw6vOXWa1o-TYDtPknIJsga6aAiFJ9-
w6ndJAov0JvTClmeyLQgBA
token2=t2
token3=t3
token4=t4
device_type=MULTIPLE_USERS
concurrent_sessions=4
lifespan=TEMPORARY
delay_registration_until_login=true

Проверьте, что устройства добавлены на странице Устройства Control Room.
Задачи, связанные с данной
Configure temporary devices
Configure your device settings to automatically delete a temporary device when the device is disconnected
from the Control Room after a certain time interval.
Generate registration key to install Bot Agent in bulk
The Control Room administrator can generate a registration key to install the Bot Agent on multiple devices
at a time in bulk.
Edit the Bot Agent installer file
Edit the Bot Agent MSI installer file to add the registration key and Control Room URL to remotely install
the Bot Agent on multiple devices.
Ссылки, связанные с данной
Совместимость Bot Agent
Перед установкой Bot Agent убедитесь, что он совместим с аппаратным и программным
обеспечением в вашем окружении.
Устройства
Устройство — это компьютер, с которого пользователь подключается к Control Room, чтобы
создавать или запускать боты. Manage devices that are registered to the Control Room through the
Devices page located in the Manage tab.

Bulk install Bot Agent using Microsoft Endpoint Configuration Manager
Install Bot Agent in bulk on multiple devices from a central location using the Microsoft Endpoint
Configuration Manager or System Center Configuration Manager (SCCM).
• Ensure that Microsoft SCCM is installed on two machines, first on a machine that hosts the Control

Room primary site and distribution server and then on a second machine that hosts the database server
to store and process all client-server communication and operations.
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• Ensure that the latest AutomationAnywhereBotAgent.msi file is downloaded from one of the
following locations based on your Control Room deployment:
• For On-Premises and Cloud: Administrator > Settings > Bot agent bulk install
• For On-Premises: <application filepath>\crui\asset folder

For example, C:\Program Files\Automation Anywhere\crui\asset.

1. Add parameters in the AutomationAnywhereBotAgent.msi file using the Orca tool.
For detailed steps, see Bulk install Bot Agent on devices.

2. Configure the Bot Agent application in SCCM.
a) Add general details, such as application name.

For example, Automation Anywhere Bot Agent Windows installer (*msi file).
b) Add content details, such as content location, settings for uninstalling, and deployment options.

Пример.
• Content location: \\crserver\msibackup\
• Settings for content uninstalling: Same as install content
• Deployment options: Download content from distribution point and run locally

c) Provide the program commands required to install the application.
Например, msiexec /i "AutomationAnywhereBotAgent.msi"/q, .

d) Provide the application detection method to determine whether the application is already installed
on a device.
The SSCM automatically detects and adds the clause for the msi file.

e) Provide user experience details, such as installation behavior (install for system or user),
logon requirement, installation visibility (interactive or hidden), and whether or not to enforce
configuration manager behavior.
Пример.
• Installation behavior: Install for system
• Logon requirement: Whether or not a user is logged on
• Installation visibility: Скрыто

Подробнее см. в разделе Create and deploy an application with Configuration Manager.
3. Distribute the application on devices using the SCCM Distribution Point (DP).

To install the Bot Agent, configure the DP on the primary server on which the Control Room is
installed. It is important to ensure that after the application is created, it is distributed properly to DP
and it can be monitored in SCCM.
Подробнее см. в разделе Install and configure distribution points in Configuration Manager.

4. Use boundaries in SCCM to virtually partition the devices identified through domains, subnets, or a
range of IP addresses.
Boundaries help in segregating the DP for different applications and can be configured through the
hierarchy configuration section from the Administration option of SCCM.
Подробнее см. в разделе Define network locations as boundaries for Configuration Manager.

5. Right-click Automation Anywhere Bot Agent application to deploy the Bot Agent using the SCCM
Applications option.
Подробнее см. в разделе Deploy applications with Configuration Manager.

6. Verify that the devices are added on the Control Room Devices page.
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Задачи, связанные с данной
Установка Bot Agent и регистрация устройств
Install Bot Agent on your local device and connect it to Control Room. In order to run боты on that local
device, ensure that you add it to the list of enabled host devices.
Bulk install Bot Agent on devices
Installing Bot Agent across multiple devices such as on-premises machines, virtual machines (VM), and
non-persistent virtual desktop infrastructure (VDI) is called Bulk install (or silent install). You must edit the
Bot Agent MSI file for bulk installation.
Edit the Bot Agent installer file
Edit the Bot Agent MSI installer file to add the registration key and Control Room URL to remotely install
the Bot Agent on multiple devices.
Ссылки, связанные с данной
Устройства
Устройство — это компьютер, с которого пользователь подключается к Control Room, чтобы
создавать или запускать боты. Manage devices that are registered to the Control Room through the
Devices page located in the Manage tab.

Создание первого бот
Выполните следующие шаги, чтобы создать первый бот, который печатает сообщение (Go be
great!), версия Automation Anywhere Hello World!
naming conventions: Keep the following considerations in mind when creating and naming :
• When creating a , ensure that your  name does not include the following special characters:

Slash (/) Asterisk (*) Comma (,)

Backslash (\) Less than sign (<) Left or right braces ({})

Question mark (?) Greater than sign (>) Left or right brackets ([])

Pipe (|) Double quotation marks (") Plus sign (+)

Percent sign (%) -- --
• Имя  должно быть уникальным. If a  with the same name exists in the same folder location to which

you have access in the public workspace, you cannot create or rename the  with this name in the
private workspace.

• Do not use  names that are reserved for the Windows operating system. The reserved  names are as
follows:

CON PRN AUX NUL COM1

COM2 COM3 COM4 COM5 COM6

COM7 COM8 COM9 LPT1 LPT2

LPT3 LPT4 LPT5 LPT6 LPT7

LPT8 LPT9 -- -- --
• Ensure that a  name does not end with a period (.) or space.
• For more information about file naming, see Microsoft guidelines.

Эта задача выполняется пользователем, который хочет создать и развернуть . Для выполнения этой
задачи вы должны обладать необходимыми правами и разрешениями, а также вам должен быть
разрешен доступ в  в качестве лицензированного пользователя.
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Прим.:  Эти шаги описывают пошаговый поток операций для начинающих пользователей.
Пошаговый поток операций отображается только при первом выполнении этих шагов.

1. Выполните вход в экземпляр Automation Anywhere Control Room.
2. Create a new бот:

a) На левой панели щелкните Автоматизация.
b) Щелкните Создать > Бот.
c) In the Create Task Bot window, enter the бот name.
d) Accept the default folder location: \Bots\

To change the default бот storage location, click Choose and follow the prompts.
e) Щелкните Создать и редактировать.

3. Вставьте action Окно сообщения.
a) Щелкните Действия.
b) Search for the Message Box пакет.

Щелкните по полю поиска Действия и введите сообщение. Щелкните по стрелке, чтобы
развернуть параметры Message Box.

c) Дважды щелкните или перетащите action Окно сообщения в Bot editor (открытая область
справа).

4. В диалоговом окне справа укажите условия для action Окно сообщения.
a) В поле Введите заголовок окна сообщения введите My first bot!.
b) В поле Введите сообщение, которое требуется отобразить введите Go be great!
c) Примите значения по умолчанию в поле Полоса прокрутки после строк и установите

флажок Закрыть окно сообщения после.

5. Щелкните Сохранить.
Ваш бот готов к работе.
Время, потраченное на создание бот, можно просмотреть в разделе Автоматизация >
Главная страница > Мои измерения. В таблице Активные Task Bot отображается время,
потраченное на создание каждого бот. Когда бот редактируется, в таблице отображается общее
время, потраченное на бот.
Например, если вы потратите 10 минут на создание и сохранение бот, то в таблице Активные
Task Bot для потраченного времени будет отображаться 10 минут. Если вы потратите еще
5 минут на редактирование того же бот, то в таблице Активные Task Bot для общего
потраченного времени будет отображаться 15 минут.
Аналогично, в поле Среднее время, потраченное на создание Task Bot на странице Мои
измерения отображается среднее время, потраченное всеми пользователями на создание всех
боты.
For example, if user 1 spends 120 minutes on Bot A, user 2 spends 2 minutes on Bot B, and user 3
spends 4 minutes on Bot C, the average time is calculated as (120+2+4)/3 = 42 minutes.
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6. Щелкните по параметрам Bot editor для просмотра и редактирования боты.
Они расположены в верхней части Bot editor.

Прим.:  Вы можете использовать окно поиска в представлениях Блок-схема, Список или
Схема и список для поиска текста, переменных или actions в бот. Эта функция может быть
полезна при просмотре или редактировании бот с длинными строками кода.

• Блок-схема. Displays actions used in an automation as a flow diagram (Default)

Прим.:  The Flow view is not available when you create or edit a бот and the бот exceeds 500
lines of code. Используйте параметр Показать представление списка для перехода к
представлению списка.

• Список. Displays the actions used in an automation as a list

Прим.:  Перетащите выбранное actions в логику задачи.

• Схема и список. Displays the actions used in an automation from both Flow and List view
aspects
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7. Запустите бот на вашем устройстве.
См. раздел Run your first бот.

Run your first бот
Run a бот from the same device that you used to create the бот.
Log in to your instance of the Automation Anywhere Control Room, and complete these steps:.
1. Установка Bot Agent и регистрация устройств
2. Set user device credentials

3. Создание первого бот

These steps describe the guided workflow for first-time users. Пошаговый поток операций отображается
только при первом выполнении этих шагов.
You can run a бот from the following devices:
• The same device you are using to log in to the Control Room.
• Another device you registered that has the same login credentials as the machine you are using to log

in to your Community Control Room or a device with defined credentials in the Control Room.

Прим.:  Windows NT LAN Manager (NTLM) is a challenge or response authentication method that enables
clients to provide their user name and password as encrypted credentials or plain text. Use Google Chrome
browser to enable the Automation Anywhere extension and capture the proxy information. After the proxy
information is captured, you can use any browser to run a бот in Automation 360.

1. Locate and select your бот.
From your Control Room dashboard left panel, select Automation. Отобразится список доступных
ботов и форм.

2. Select the бот to run.
From the Files and folders table, mouse over the ellipsis (three stacked dots) to the right of your
бот's name.
The Edit TaskBot panel appears.
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3. Click the Run Task bot icon.
The Run bot now window opens. In the Task Bots table, your бот is selected to run.

4. Щелкните Вперед.
The Device tab opens with a table of one or more registered devices.

5. If your device is not already selected, select your device to run the бот, and click the right arrow.
6. Click Run bot now.

Control Room uses the credentials in your profile to log in to the device you selected and runs the бот.
The In progress activity window opens with the status of the running бот. When the бот is done, it
disappears from this window.

7. Click Historical to see if your бот ran successfully.
Watch the following video on how to run your first бот in the Community Edition:

Build боты using variables, actions, and the Universal Recorder. См. раздел Get started building боты.

Обновление до последней версии Automation 360
Если вы уже используете Automation 360 On-Premises, этот продукт можно обновить до последней
версии Automation 360.
• Перед каждым обновлением версии обязательно создайте резервную копию базы данных,

репозитория и файлов конфигурации установки.
• Убедитесь, что используете одну из трех предыдущих версий, начиная с последней (версия n-3,

где n относится к последней версии).
Например, для обновления до версии Automation 360 v.21 необходимо иметь версию v.20, v.19
или v.18. Однако для обновления версии v.15 до Automation 360 v.21, необходимо сначала
обновить до версии v.18, а затем обновить до версии Automation 360 v.21. Во втором сценарии
обязательно выполните резервное копирование данных версии v.15 перед обновлением до v.18, а
затем выполните резервное копирование данных версии v.18 перед обновлением до версии v.21.

Важное замечание:
• You must perform the following steps before you upgrade to the latest version of Automation 360:

• Ensure you reconfigure the settings for log4j2.xml files after the installation because when you
upgrade, the previous settings set at log level in log4j2 change back to default.

• Configure the SSL settings (certificates) every time you upgrade.

• При обновлении версии Automation 360, более ранней, чем n-3, до последней версии, может
появиться сообщение об ошибке Elasticsearch Open Distro. Перед обновлением удалите несколько
индексов application_log из Elasticsearch, чтобы освободить место на диске для обновления.
Подробнее о пределе индексов Elasticsearch см. в разделе Cluster-level shard allocation and routing
settings.

• Перед обновлением On-Premises Automation 360 версии 22 до последней версии ознакомьтесь с
информацией здесь: A360 | Upgrading to A360.23, A360.24, A360.25 from A360.22 (A-People login required)
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• When you update to Automation 360 v.25 from an earlier release, an error might occur when the
database server includes the instance name. In such a scenario, remove the instance name in the
database server and continue with the installation.
For information on removing the instance name from the database server, see Error parsing the SQL
instance name while upgrading to Automation 360 v.25 (A-People login required).

1. Войдите на сайт поддержки Automation Anywhere, чтобы загрузить последнюю версию
установочного файла Automation 360: A-People Downloads page (Login required).

2. На странице загрузок щелкните ссылку на файл установки последней версии Automation 360.
3. Щелкните Настройка установки, а затем щелкните либо Установка Linux, либо

Установка Windows в зависимости от операционной системы машины, на которую вы хотите
установить Automation 360.

4. Загрузите файл Automation360_Build_<build-number>.<file-extension>.
5. Установите последнюю версию Automation 360, не удаляя текущую.

Installing Control Room On-Premises

Важное замечание:  В более новой версии Automation 360 необходимо использовать базу
данных SQL текущей версии.

Понятия, связанные с данным
Миграция в Automation 360

Обновление Automation 360 на Microsoft Windows Server с
помощью сценариев
Обновление Automation 360 с помощью настраиваемого сценария с параметрами для сохранения
существующих пользовательских конфигураций.
To perform the task, you must have a  administrator account with the required rights and permissions.
• Verify Automation 360 On-Premises prerequisites.
• Убедитесь в том, что у вас есть следующее.

• Automation Anywhere Control Room installation file
• TLS certificate
• License file

Sample config.properties file:  Для справки вы можете найти пример файла config.properties в
конце страницы.

Создайте и запустите сценарий PowerShell для обновления Automation 360.
1. Создайте сценарий PowerShell с необходимыми параметрами.

Ниже приведен пример сценария PowerShell для обновления Automation 360.

# Script Begins
# It fetches Data from config.properties file present under the same
 directory level

$PropertyFilePath = 'C:\script\config.properties'
$rawProperties = cat $PropertyFilePath
$propertiesToConvert = ($rawProperties -replace '\\' ,'\\') -join
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[Environment]:: NewLine;
$properties=ConvertFrom-StringData $propertiesToConvert
$env:SEE_MASK_NOZONECHECKS = 1

# Setting up the logger and InstallerRoot Directory

$baseLogFilePath=$properties.baseLoggingDirectory
$logFilePath=$baseLogFilePath+'Express_CR_Installation_Scenario1.txt'
$baseInstallerPath=$properties.baseInstallerDirectory
$installer_name_regex=$properties.installerNameRegex

# Logging Begins

Start-Transcript -Path $logFilePath -Append -IncludeInvocationHeader

$binary = Get-ChildItem $baseInstallerPath | Where-Object { $_.FullName -
imatch $installer_name_regex }
$a = $binary.FullName
$final_commandline = " /update /s /v/qn /v""/L*v
 CR_Onprem_Installationlog_Scenario1.txt"""

# Recording the Start Time
Get-Date -Format g

# Invoking the Installer here
$processdetail = (Start-Process -FilePath $a -ArgumentList
 $final_commandline -Wait -Passthru).ExitCode

# Recording the End  Time
Get-Date -Format g

Stop-Transcript

2. Необязательно: Настройте сценарий, включив в него параметры в соответствии с вашими
требованиями.

3. Сохраните сценарий на сервере установки.
4. Выполните вход на сервер в качестве администратора.
5. Запустите PowerShell в режиме администратора.
6. Выполните следующее:

Set-ExecutionPolicy Unrestricted -Scope CurrentUser -Force

.\install.ps1

Прим.:  Журналы автоматической установки хранятся в папке, из которой запускается сценарий
установки. Например, если запустить сценарий из папки C:\Silent Install, то журналы
сохраняются в папке C:\Silent Install.
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7. Проверьте следующее.
• Все службы Automation Anywhere запущены в диспетчере задач Windows.

Verifying Automation Anywhere services
• Вы можете выполнить вход в Control Room с помощью поддерживаемого браузера.

Вход в Automation Anywhere Control Room
• Вы можете установить необходимую лицензию в Control Room.

Installing additional licenses
• Все автоматизации (развернутые и запланированные) выполняются в Control Room.

Действия

Пример файла config.properties

# Properties utilized across all Scenarios

# Default/Express Mode Params

baseLoggingDirectory=C:\script\logs\
baseInstallerDirectory=C:\script\
installerNameRegex=AutomationAnywhereEnterprise_A2019

Install and update Automation 360 IQ Bot
This collection of topics guide you through the process of installing or setting up Automation 360 IQ Bot
On-Premises and Cloud.
• Automation 360 IQ Bot Cloud deployed
• Automation 360 IQ Bot On-Premises

Automation 360 IQ Bot On-Premises

Шаг 1. Предустановка Go to Automation Anywhere support site and
download the Automation 360 IQ Bot On-Premises
package:
A-People Downloads page (Login required)

Прим.:  Automation 360 IQ Bot On-Premises uses
a 3-node cluster to ensure high availability (HA).
High availability and disaster recovery overview

Review and verify the requirements and options
before installing IQ Bot. This topic provides you
with important information about the supported
operating systems, hardware and software
requirements, and the prerequisite steps you have
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to complete even before you begin the installation
process.

IQ Bot installation
prerequisites

Verify the hardware,
software, and
configuration required
to install IQ Bot On-
Premises.

Шаг 2. IQ Bot installation Install IQ Bot using any of the following installation
options:

Installing IQ Bot in
Express mode

Install IQ Bot in Express
mode with the default
settings.

Установка IQ Bot в
пользовательском
режиме

Пользовательский
режим используется
для установки IQ
Bot со сведениями о
конфигурации.

Installing IQ Bot in
Cluster mode

Install IQ Bot in Cluster
mode for improved
throughput. IQ Bot
supports clustering
of up to five IQ Bot
installations.

Installing IQ Bot in
Cluster mode on Amazon
EC2

Install IQ Bot in the
cluster mode on Amazon
Elastic Compute Cloud
(Amazon EC2).

Шаг 3. Пост-установка After downloading IQ Bot, register with the
Control Room and do the various configurations as
required. You would also go through the checklist
to ensure all services, databases, tables, and
configuration settings are in place.

Контрольный список
после установки

Проверьте, что IQ Bot
установлен, убедитесь,
что службы IQ Bot
запущены, используя
API-интерфейсы
проверки
работоспособности, и
зарегистрируйте IQ Bot
в Control Room.

Шаг 4 (необязательный). Install an OCR
engine

Во время установки IQ Bot система в качестве
модуля Распознавание текста (OCR) по
умолчанию устанавливает последнюю версию
Tesseract Optical Character Reader. Чтобы
использовать другой модуль, выполните
действия, указанные по соответствующей
ссылке:
Use Microsoft Azure Computer Vision OCR engine
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Use ABBYY FineReader Engine Распознавание
текста (OCR) engine in IQ Bot

Use Google Vision API OCR engine

Использование модуля Распознавание текста
(OCR) Tegaki API

Шаг 5. Login and set up the Control Room Create and register IQ Bot specific users in the
Control Room. Learn more about IQ Bot roles and
access permissions:
IQ Bot user personas and roles

Далее: Connect to IQ Bot with the assigned
user role, and begin creating learning
instances

Automation 360 IQ Bot

Automation 360 IQ Bot Cloud deployed

Follow these steps to deploy and register as a user:

Шаг 1. Предустановка If you are your company's principal administrator
and ordered Cloud deployed Automation 360
IQ Bot, you receive an email from Automation
Anywhere with your URL and credentials.

Шаг 2. Вход в IQ Bot To log in to Automation 360, open the Control
Room URL in your browser, enter your credentials in
the login screen, and click Log in.
Вход в Automation Anywhere Control Room

Шаг 3. Set up the Control Room Create and register IQ Bot specific users in the
Control Room. Learn more about IQ Bot roles and
access permissions:
IQ Bot user personas and roles

Далее: Connect to IQ Bot with the assigned
user role, and begin creating learning
instances

Go to the Control Room dashboard to access the IQ
Bot URL link.
Automation 360 IQ Bot

Понятия, связанные с данным
Automation 360 IQ Bot
Automate document-centric business processes, end to end, by using IQ Bot, a web-based, Cloud-native
intelligent document processing solution that can read and process complex documents and email. This
solution combines RPA with AI techniques to extract and classify semi-structured and unstructured data.
Начните с Cloud Automation 360
Use these tasks to start creating and using боты with Automation 360 Cloud.
Миграция в Automation 360 IQ Bot
Миграция — это процесс перехода с более ранних версий IQ Bot (Enterprise 11.x, 6.x или 5.x)
на последнюю версию Automation 360 IQ Bot. Сюда входит репликация существующих базы
данных и репозитория, преобразование боты в формат Automation 360 и миграция всех обучаемых
экземпляров.
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IQ Bot installation prerequisites
Verify the hardware, software, and configuration required to install IQ Bot On-Premises.

Прим.:  This page applies to On-Premises installations only. For Cloud deployment, see Automation 360 IQ
Bot Cloud deployed.

Hardware and software requirements

Важное замечание:  As a prerequisite step, open ports 4369 and 25672 and add inbound firewall rules
to allow traffic to these ports on each target machine. To add nodes to the cluster, sync the RabbitMQ
v3.8.18 cookies to enable running any RabbitMQ v3.8.18 commands. If IQ Bot is already installed on the
target machine, clean up and remove the existing cookies.

Automation 360 IQ Bot version compatibility

IQ Bot system requirements

Prerequisite

IQ Bot prerequisite steps

IQ Bot service configuration

IQ Bot Windows services

RabbitMQ v3.8.18 and Erlang/OTP upgrade

Installing IQ Bot in Cluster mode on machines with IQ
Bot preinstalled

Prerequisites for installing IQ Bot in Express mode

Installation limitations

Database encryption limitations
Installation time increases when encryption of the SQL database backup file is in progress, and also when
the database backup file size increases.
The encryption process of the SQL database might result in the creation of large transaction logs. Allocate
at least 3 to 4 times more disk space than the database backup file size.

Прим.:  The following list of installation packages are not supported from Automation 360.27 release
onwards:
• On-Premises custom fresh installation - Custom installation + HTTP + SQL authentication + local

account installation
• On-Premises Express fresh installation
• On-Premises without internet fresh installation
• On-Premises GCP fresh and upgrade
• On-Premises SDS fresh installations (AD and Non-AD)
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• On-Premises Migration from IQ Bot 11.x to On-Premises Automation 360.x using Migration Assistant
Tool (MAT).

Прим.:  The base version must be Version 11.3.5.6. Any customer on IQ Bot 11.x version prior to On-
Premises must first upgrade to On-Premises and then migrate to Automation 360.27.

Задачи, связанные с данной
Installing IQ Bot in Express mode
Install IQ Bot in Express mode with the default settings.
Установка IQ Bot в пользовательском режиме
Пользовательский режим используется для установки IQ Bot со сведениями о конфигурации.

IQ Bot system requirements
Review the operating system and database compatibility, database information, and the hardware and
software requirements for Automation 360 IQ Bot.

Legal disclaimer:  The information provided in this workflow might vary depending on which offering
is being used. Administrative instructions might not be applicable to Automation 360 IQ Bot Community
Edition.

Прим.:  When you migrate from any of the earlier IQ Bot versions (11.x or 6.x) to Automation 360 IQ Bot,
ensure that you update the Microsoft Windows Server Operating System to one of the versions listed in the
table below.

The following table lists the Operating System and database compatibility with Automation 360 IQ Bot On-
Premises:

Operating System Supported
platforms

Тип базы данных Database
version

Database
edition

Microsoft Windows
Server:
• 2019 Data Center
• 2016 Data Center
• 2016 R2 Standard
• 2019 R2 Standard

• Microsoft Azure
Virtual Machines

• Amazon Elastic
Compute Cloud
(Amazon EC2)

• Google Cloud
Platform

• Microsoft SQL
Azure (RTM)

• Amazon
Relational
Database
Service
(Amazon RDS)

• Microsoft SQL
Server

• 2019
• 2017
• 2016
• 2014
• 2012

• Экспресс
• Стандартная
• Предприятие

The following table provides the required database information:

Microsoft SQL Server and Amazon RDS databases

Required information Описание

Database (Сервер SQL) authentication Provide credentials for a Microsoft SQL Server user who
has permission to connect to the database.

Имя базы данных IQBot

Database port Default: 1433

© 2023 Automation Anywhere. All rights reserved.     1077



    Automation Anywhere - Install and update Automation 360

Microsoft SQL Server and Amazon RDS databases

Required information Описание

Service credentials Provides the user with the following permissions:
• CONNECT SQL
• CREATE ANY DATABASE
• VIEW ANY DATABASE

Прим.:

If you are using an older version of the Microsoft SQL Server which does not support TLS 1.2,
then you must keep a IQ Bot database backup and update to a Microsoft SQL Server version that
supports TLS 1.2. For more information, see https://support.microsoft.com/en-us/topic/kb3135244-
tls-1-2-support-for-microsoft-sql-server-e4472ef8-90a9-13c1-e4d8-44aad198cdbe.

Требования к аппаратному обеспечению

IQ Bot Minimum requirements

Application server • 32 GB RAM
• 8 Core Processor with support for AVX

instructions set (this is a requirement starting
from A2019.19)

• 500 GB hard disk space
• Ensure drive C has 100 GB plus free hard disk

space

For all IQ Bot related database servers • 16 GB RAM
• 8 Core Processor
• 500 GB hard disk space

Прим.:  If you are hosting IQ Bot databases
along with other application databases,
ensure the hardware resources are increased
proportionately.

Microsoft Azure SQL Database: production
environment

• vCore model (recommended)
• DTU model (Premium tier recommended)
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Software requirements

Software Сведения

Database Management System Матрица сравнения функций Automation 360 IQ
Bot

Automation Anywhere Control Room Automation 360 IQ Bot version compatibility

Веб-браузеры Google Chrome 80 (or later)
Microsoft Edge Chromium 98 (or later)
Mozilla Firefox 80 (or later)

SMB File Share Azure File Share with Server Message Block 2.0
and 3.x (SMB) protocol.

Зависимости Automation 360 requires the following software,
which is automatically installed during the
installation:
• Microsoft .NET Framework v4.7.2

The system prompts for a restart to complete
the update.

• Microsoft Visual C++ Redistributable 2017
x64 package

• Erlang 25.1 (13.1)
• RabbitMQ 3.10.8
• NodeJS v14.20.0
• Microsoft SQL Server 2012 Native Client- QFE
• Python 3.11.0 (64 bit)
• Java Virtual Machine (JVM) 8

Прим.:  In a cluster environment, all
dependencies are installed on each machine
where IQ Bot is installed.

Ссылки, связанные с данной
IQ Bot installation prerequisites
Verify the hardware, software, and configuration required to install IQ Bot On-Premises.
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IQ Bot prerequisite steps
Complete the steps before you begin installing IQ Bot.
1. User needs to have either the SYSADMIN role or the following privileges for SQL database account as

this is used during installation to create database and run the BULK INSERT statement.
• SQL connection (CONNECT SQL)
• Database creation (CREATE ANY DATABASE)
• View any database (VIEW ANY DATABASE)

Прим.:  Installation with Microsoft Azure SQL requires the dbmanager role.

Прим.:  Installation with AWS RDS requires a role with the above three privileges. These privileges
are already assigned to the db_owner role in RDS.

Grant permissions for a specific database user and see the permissions for that role using the
following TSQL query:
SELECT * FROM fn_my_permissions(NULL, 'SERVER').

2. First enable HTTPS, to configure IQ Bot with HTTPS. Keep the following HTTPS certificate files ready
for use:
• Control Room certificate in .crt format (Certificate Authority list bundle).
• Control Room certificate in .crt format (Server side public certificate).
• IQ Bot server certificate in .pfx and .crt format.

Важное замечание:  Install the .crt certificates for Control Room manually to their appropriate
certificate stores.

Прим.:  See Configuring IQ Bot with HTTP when Control Room is configured with HTTPS for more
information.

3. Keep the following ports open because they are used by IQ Bot services:
• Application access port (configurable): 3000
• Database access port (configurable): 1433
• Internal application services ports (fixed): 8100, 9002, 9991, 9992, 9995, 9996, 9997, 9998, 9999
• Inbound listening ports:

• 47100-47200 on IQ Bot server for IQ Bot-Control Room communication.
• 47100-47200 and 47500-47600 on Control Room server.

• RabbitMQ v3.8.18
• Порт. 5672
• Порт. 5673

4. If your Сервер SQL version is older than SQL Server Native Client 2012, a dialog box appears, giving
you the option to upgrade. Open services.msc and stop the Сервер SQL (MSSQLSERVER) to do
the upgrade. Then continue with the installation process.

5. During the upgrade process, the installer will detect existing learning instances from a previous version
of IQ Bot. To retain the original classifier for those learning instances, select that earlier version of IQ
Bot from the drop-down list. This ensures consistency in the behavior of the learning instances with
that earlier version.
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6. IQ Bot installer is case sensitive about the user account created for Сервер SQL or Окноs.

Важное замечание:  Use the username as it appears on the Microsoft SQL Server Management
Studio under Security > Logins. If it was created in upper case, then use upper case for the
username to launch the installer. Additionally, verify if the collation database property is set to case
sensitive.

IQ Bot service configuration
In some IQ Bot deployments, the service account can be different from the login account. As an
administrator, provide the service credentials during installation.
IQ Bot Installer supports service credentials during Microsoft Windows or SQL server authentication. When
installing Services for IQ Bot, in the service installation window, the Local System Account check box is
selected by default. You can deselect this and provide a username and password.

Прим.:
• Use Windows authentication with a valid system administration user in service configuration.
• Use Windows authentication with a local system for a system administration user.
• When using a remote SQL server to create a database, the combination of local system account for

service credentials and Windows authentication for SQL connection is not supported.
• The service account used for IQ Bot services must have full rights to the IQ Bot installation folder.

If you do not select the Local System Account checkbox, provide your user credentials to run the IQ Bot
Services.

Прим.:
• A valid system administrator user requires Окноs authentication with the Services user credentials.
• При вводе учетных данных пользователя убедитесь, что они связаны с доменом. For example:

example.com/testuser. User is unable to use this function without the domain.

See Установка IQ Bot в пользовательском режиме to view the use of service credentials in IQ Bot.
Ссылки, связанные с данной
IQ Bot installation prerequisites
Verify the hardware, software, and configuration required to install IQ Bot On-Premises.

IQ Bot Windows services
IQ Bot Windows services are automatically installed when running the installation and setup.
Make sure that the following Windows services are set when installing IQ Bot.

Имя службы Описание

Automation Anywhere Cognitive Alias IQ Bot service that manages domains, domain
dictionary, aliases, and languages supported in
the system.

Automation Anywhere Cognitive Application IQ Bot service that provides support for all
Control Room integration points and information
about IQ Bot application configuration.
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Имя службы Описание

Классификатор Automation Anywhere Cognitive IQ Bot service that provides support to classify
documents in a learning instance, into different
groups.

Automation Anywhere Cognitive Console IQ Bot user interface.

Прим.:  In contrast to other services, the
Automation Anywhere Cognitive Console service
runs on the local user account rather than the
domain or service account.

Automation Anywhere Cognitive File Manager IQ Bot service that manages documents in the
file management system.

Automation Anywhere Cognitive Gateway-2 IQ Bot Gateway for all the IQ Bot backend
services, handling authorization and validation of
request/response of APIs.

Automation Anywhere Cognitive MLScheduler
Service

IQ Botservice scheduler for ML Web Service.

Automation Anywhere Cognitive MLWeb Service IQ Bot service that prepares models based on
user validation.

Automation Anywhere Cognitive Projects IQ Bot service managing learning instances.

Automation Anywhere Cognitive Report IQ Bot dashboard.

Automation Anywhere Cognitive Валидатор IQ Bot service to manage documents that go for
validation.

Automation Anywhere Cognitive Visionbot
Manager

IQ Bot service to manage vision bots in the
system.

Automation Anywhere Cognitive VisionbotEngine
Service

IQ Bot service to process document based on
different inputs provided.

Прим.:  All the services can be configured either in Local System or Domain account when IQ Bot is
installed in Custom mode. For IQ Bot installed in Express mode, all the services are run in Local System
account.

Ссылки, связанные с данной
IQ Bot installation prerequisites
Verify the hardware, software, and configuration required to install IQ Bot On-Premises.

RabbitMQ v3.8.18 and Erlang/OTP upgrade
The IQ Bot installation package includes the RabbitMQ v3.8.18 version 3.7.17 and Erlang/OTP version 22.0.
For Automation 360 IQ Bot, ensure that you download the Microsoft Visual C++ Redistributable 2017 x64
version because it is required for the latest version of Erlang/OTP.
The following information explains different scenarios for upgrading RabbitMQ v3.8.18/Erlang/OTP:
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• Fresh installation of IQ Bot
For a fresh installation, you do not have to perform any additional steps, as RabbitMQ v3.8.18 Erlang/
OTP are included in the IQ Bot installation package. These get installed automatically on the machine
during the installation process.

• Upgrade from previous version of IQ Bot
Uninstall the earlier version of RabbitMQ v3.8.18 / Erlang/OTP.
1. Uninstall existing RabbitMQ v3.8.18 and Erlang/OTP from the Control Panel.
2. Run the Cleanup_Components.bat file as an administrator.
3. Restart your machine.
4. After running the scripts, verify that RabbitMQ v3.8.18 and Erlang/OTP are removed completely. If

not, uninstall them manually to delete any remaining files from the program files folder, and then
repeat Step 3.

• An earlier version of RabbitMQ v3.8.18/Erlang/OTP exists on the machine and the user
wants to upgrade to the latest versions:
You need to manually remove any older versions from the system using a batch utility file provided by
Automation Anywhere. Contact the Automation Anywhere Support team to get the utility. You can then
proceed with installing IQ Bot.

Ссылки, связанные с данной
IQ Bot installation prerequisites
Verify the hardware, software, and configuration required to install IQ Bot On-Premises.

Installing IQ Bot in Cluster mode on machines with IQ Bot preinstalled
If you have IQ Bot already installed on your machine, uninstall IQ Bot, stop RabbitMQ service, and clean
the existing RabbitMQ v3.8.18 cookies before installing IQ Bot in Cluster mode.
• Open ports 4369 and 25672 and add inbound firewall rules to allow traffic to these ports on each target

machine.
• To add nodes to the cluster, sync the RabbitMQ v3.8.18 cookies to enable running any RabbitMQ

v3.8.18 commands . If IQ Bot is already installed on the target machine, clean up and remove the
existing cookies.

Follow the clean up procedure before setting up a cluster:
1. Uninstall IQ Bot from Program and Features.
2. Stop the RabbitMQ v3.8.18 service, by running the command: net stop RabbitMQ /yes.
3. Uninstall RabbitMQ v3.8.18 from %Programfiles%\RabbitMQ Server\uninstall.
4. Stop the epmd.exe and its descendants by running this command: Taskkill /IM epmd.exe /F.
5. Stop erl.exe and erlsrv.exe and its descendants by running the following commands:

a) Taskkill /IM erl.exe /F

b) Taskkill /IM erlsrv.exe /F

6. Uninstall Erlang from %Programfiles%\erl8.2\Uninstall.
7. Remove the following folders if they were not removed from the uninstall:

a) %Programfiles%\Rabbit MQ Server

b) %Programfiles%\erl8.2
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8. Remove the following folders: %appdata%\RabbitMQ, %WINDIR%\.erlang.cookie,
%USERPROFILE%\.erlang.cookie.

Do the following after completing the installation steps:
• The load balancer details for the following are available:

name of the load balancer
порт
type of security used (For example, HTTP or HTTPS)

• Share a folder for configuring the output path.

Прим.:  The user installing IQ Bot requires appropriate access permissions.

Ссылки, связанные с данной
IQ Bot installation prerequisites
Verify the hardware, software, and configuration required to install IQ Bot On-Premises.

Prerequisites for installing IQ Bot in Express mode
Complete the prerequisites to set up IQ Bot in express mode.
Complete the following steps before you begin installing IQ Bot in express mode.
1. Install the Control Room in a version that is compatible with IQ Bot.

Automation 360 IQ Bot version compatibility

2. Ensure that SQL Server Browser service is up and running before installing IQ Bot in express mode.
3. Start the SQL Server Browser service in any one of the following ways:

Option 1 a. Launch the SQL Server
Configuration Manager.

b. Go to SQL Server Services.
c. Start the SQL Server Browser

services.

Option 2 a. Launch the Task Manager.
b. Go to the Services tab.
c. Start the SQLBrowser services.

4. Use the Automation_Anywhere_IQ_BOT_<version_number>.exe file to install IQ Bot.
5. The setup wizard guides you through the installation process. During installation, any software

dependencies or missing prerequisites are installed.

Прим.:  When a file is uploaded to a fresh IQ Bot instance, the database administrator is unable to
extract any information about that file from the database as the data is encrypted.

6. Enable SQL authentication.
Enable the TCP protocol on the SQL server and listen to the local host at port 1433.

7. Set the SQL server instance name to AACRSQLEXPRESS.
8. Create a user with sysadmin permissions for username aaadmin, and password aabots@123.
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See Installing IQ Bot in Express mode for steps to install in Express mode.
Ссылки, связанные с данной
IQ Bot installation prerequisites
Verify the hardware, software, and configuration required to install IQ Bot On-Premises.

Installing IQ Bot in Express mode
Install IQ Bot in Express mode with the default settings.
Complete the prerequisites: Prerequisites for installing IQ Bot in Express mode

1. Double-click the Automation_A360_IQ_BOT_<build number>.exe file.
2. In the IQ Bot Setup Wizard, click Yes, and then click Next.
3. In the Prerequisites page, review the prerequisites and click Next.
4. In the License Agreement page, review the license agreement, accept the terms, and click Next.

IQ Bot runs a pre-installation check.
Появится экран предварительной установки с приложениями, не имеющими требуемой версии и
необходимых портов, вместе со службами, занимающими эти порты.

5. If the pre-installation check is not successful, uninstall the mentioned software and free the required
ports.
a) Щелкните Повторить.
b) When the pre-installation check is successful, click Next.

Открывается страница Тип установки с настройками Экспресс и Пользовательский.

Прим.:  Во время экспресс-установки устанавливается IQ Bot на основе HTTP без поддержки
Active Directory.

6. Select Express and click Next.
7. After you click Next, the unable to proceed with installation message might appear if the

installer is unable to communicate with the Control Room or SQL Express.
If the error message appears, perform these steps:
a. Click Back to review or change the installation settings. Alternatively, exit the Setup Wizard and

click Cancel.
b. In the confirmation dialog box, click Yes to exit the Setup Wizard.

This rolls back all the changes.
c. Click No to resume.

8. In the Ready to install the program page, click Install.
The express installation begins and the system shows the Finished page after a few minutes to
indicate a successful installation.

IQ Bot is installed with the following default settings:
Security type: None (HTTP)
Web configuration: <web url:port>
Database configuration: <database url:port> (user: aaadmin ; Authentication: SQL)
Database password: aabots@123
Host Gateway: <gateway:port> (SSL Offloading: No)
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Output path: C:\Users\Public\Documents\Automation Anywhere IQBot Platform
\Output\
Logging Path: C:\Users\Public\Documents\Automation Anywhere IQBot Platform\Logs
\
Logging path Automation 360 IQ Bot A360.21 onward: C:\Users\Public\Documents
\Automation 360 IQBot Platform\Logs\
Installation path for Automation 360 IQ Bot: C:\Program Files (x86)\Automation Anywhere
 IQ Bot A2019\
Installation path for Automation 360 IQ Bot A360.21 onward: C:\Program Files
 (x86)\Automation 360 IQ Bot\

Проверьте, что IQ Bot установлен, убедитесь, что службы IQ Bot запущены, используя
API-интерфейсы проверки работоспособности, и зарегистрируйте IQ Bot в Control Room.
Контрольный список после установки

Установка IQ Bot в пользовательском режиме
Пользовательский режим используется для установки IQ Bot со сведениями о конфигурации.
1. Запустите установочный файл Automation_A360_IQ_BOT_<номер сборки>.exe от имени

администратора.
2. В первый раз после установки может потребоваться перезагрузка сервера. Перезапустите

процесс установки IQ Bot при необходимости.
3. В мастере настройки IQ Bot Automation Anywhere щелкните Далее.

a) Щелкните Далее в окне Предварительные условия.

4. Прочитайте лицензионное соглашение, примите условия и щелкните кнопку Далее.
IQ Bot выполняет проверку перед установкой.
Появится экран предварительной установки с приложениями, не имеющими требуемой версии и
необходимых портов, вместе со службами, занимающими эти порты.

5. Если проверка перед установкой не была успешной, удалите упомянутое программное
обеспечение и освободите необходимые порты.
a) Щелкните Повторить.
b) Когда проверка перед установкой пройдет успешно, щелкните кнопку Далее.

Открывается страница Тип установки с настройками Экспресс и Пользовательский.

Прим.:  Во время экспресс-установки устанавливается IQ Bot на основе HTTP без поддержки
Active Directory.

6. Выберите вариант Пользовательский и щелкните кнопку Далее.
7. В окне Конфигурация базы данных добавьте указанные ниже данные.

a) Имя хоста или IP. Введите имя хоста или IP-адрес.

Прим.:  Подчеркивание в имени хоста не допускается.

b) Порт. Введите номер порта.

Прим.:  Если на целевом компьютере локально установлена база данных Microsoft Windows
SQL Server Express, в качестве имени хоста автоматически подставляется localhost, а в
качестве порта — 1433.
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8. Необязательно: To connect to your CyberArk vault to store the custom keys for encrypting and
decrypting IQ Bot data, select the Use CyberArk external vault option and provide the following
connection details to your CyberArk account.
• Vault URL: The CyberArk URL endpoint on the CyberArk server
• Application ID: The CyberArk-issued Application ID
• Object and Safe Name: Identify the custom key in CyberArk
• Client certificate path: The Control Room Client Certificate certificate used to authenticate

to CyberArk. If the certificate is distributed in a passphrase protected file, you must enter the
passphrase.

• (Optional) Server certificate: You can load the CyberArk AIM Server certificate to the Control
Room trust store here to make sure that the Control Room will trust the CyberArk server.

Сведения о подключении получите у поставщика CyberArk или у специалистов ИТ-группы.
9. Введите указанные ниже данные сервера базы данных на странице Конфигурация базы

данных и щелкните Далее.
Опция Описание

Вариант 1 Укажите свои учетные данные пользователя
Microsoft Windows SQL Server для входа на
сервер базы данных.

Вариант 2 Если установить флажок Использовать
аутентификацию Windows, не нужно
предоставлять учетные данные Microsoft
Windows для входа на сервер базы данных,
поскольку программа установки обнаруживает
их автоматически.

Сообщение об ошибке Не удалось подключиться к SQL-серверу с заданной
конфигурацией появляется при указанных ниже условиях.
• Неправильные имя сервера/IP-адрес и номер порта
• Неправильные учетные данные сервера базы данных
• Недостаточные права пользователя для подключения к базе данных

Прим.:
• При установке IQ Bot настройте учетные данные недавно размещенной базы данных в

Microsoft Azure SQL PaaS. Для проверки учетных данных и перехода к следующему экрану
может потребоваться до 300 секунд. Однако если локальная база данных для IQ Bot уже
перенесена на Microsoft Azure SQL PaaS перед установкой, задержки при настройке базы
данных не будет.

• IQ Bot не поддерживает логику повторных попыток для Microsoft Azure SQL PaaS. Избегайте
использовать IQ Bot во время запланированных мероприятий по техническому обслуживанию
в базе данных Microsoft Azure SQL.

• Если IQ Bot и экземпляр базы данных уже существуют, а IQ Bot устанавливается повторно,
IQ Bot получает экземпляр базы данных по умолчанию во время установки.

• Windows authentication with the local system works only if the NT Authority/System user has
system administrator permissions.

• Комбинация учетной записи Local System для служебных учетных данных и аутентификации
Microsoft Windows для подключения SQL не поддерживается, если для создания баз данных
вы используете удаленный SQL-сервер.
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10. В окне Конфигурация служб установите флажок Локальная системная учетная запись и
щелкните кнопку Далее.
• Установите флажок Локальная системная учетная запись, чтобы службы запускались в

контексте локальной системной учетной записи.
• Если флажок Локальная системная учетная запись не установлен, укажите свои учетные

данные пользователя для запуска служб IQ Bot.
• Для действительного пользователя системного администратора требуется аутентификация

Windows с помощью учетных данных пользователя «Службы».
• При вводе учетных данных пользователя убедитесь, что они связаны с доменом. For

example: example.com/testuser. Пользователь не может воспользоваться этой
функцией без домена.

11. В окне IQ BotКонфигурация портала введите указанные ниже данные и щелкните Далее.

Безопасность портала

Выберите тип безопасности: HTTPS или HTTP.

Выбрав HTTPS, убедитесь, что можете просмотреть, а затем выбрать
действительный файл сертификата PFX в поле Путь к сертификату.
Configuring IQ Bot with HTTP when Control Room is configured with HTTPS

Выбрав HTTP, перейдите к следующему шагу.

Введите действительную парольную фразу сертификата в поле Парольная фраза
сертификата.

Конфигурация портала

Имя хоста или IP Введите имя хоста или IP-адрес IQ
Bot или используйте автоматически
заполняемое значение по умолчанию,
которое представляет собой полное
доменное имя (FQDN) компьютера, на
котором устанавливается IQ Bot.

Прим.:  По умолчанию автоматически
подставляется полное доменное имя
компьютера, на котором устанавливается
IQ Bot.

Порт Введите номер порта или используйте
автоматически заполняемое значение по
умолчанию — 3000.

12. В окне Конфигурация балансировщика нагрузки выполните указанные ниже действия.
a) Установите флажок Использовать то же, что и портал IQ Bot, чтобы использовать для

балансировщика нагрузки те же имя хоста и номер порта, которые были указаны ранее
в окне Конфигурация портала в IQ Bot. Этот флажок установлен по умолчанию. Этот
флажок следует оставить установленным при выполнении любого указанного ниже условия.
• IQ Bot устанавливается на одном компьютере.
• Конфигурацию балансировщика нагрузки планируется оставить такой же, как на

странице IQ Bot.
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b) Если значения конфигурации балансировщика нагрузки отличаются от значений на
странице IQ Bot, снимите флажок Использовать то же, что и портал IQ Bot и введите
указанные ниже значения.
• Имя хоста балансировщика нагрузки: Введите имя хоста или IP-адрес.
• Порт балансировщика нагрузки. Введите номер порта.

c) При необходимости установите флажок Балансировщик нагрузки может
обрабатывать разгрузку SSL и щелкните Далее.

Прим.:  Если во время настройки балансировщика нагрузки задать режим безопасности
HTTPS в окне Конфигурация портала IQ Bot, разгрузка SSL по умолчанию отключена.
Чтобы включить разгрузку SSL для балансировщика нагрузки, выберите HTTP в окне
Конфигурация портала IQ Bot.

Ниже приведены некоторые дополнительные возможности настройки балансировщика
нагрузки.
• При установке IQ Bot в AWS, чтобы обеспечить доступ к серверу IQ Bot из внешнего

местоположения, замените имя шлюза именем, предоставляемым общедоступной
службой DNS.

• При повторной установке имя хоста балансировщика нагрузки и порт автоматически
определяются программой установки на основе данных предыдущей установки,
сохраненных в файле Control Room. Изменяйте их при необходимости, поскольку это
полезно при установке нескольких экземпляров IQ Bot для масштабируемости (чтобы не
пришлось запоминать сведения для каждого экземпляра).

• При использовании HTTPS-сертификата в балансировщике нагрузки с псевдонимом,
который отличается от имени хоста машины (FQDN), введите псевдоним в качестве
имени хоста.

• Программа установки берет значение из окна ПорталКонфигурация в IQ Bot (с
предыдущей страницы), но показывает ранее полученные значения в отключенных
текстовых полях из окна Control Room.

13. В окне Папка назначения внесите необходимые изменения в папки назначения и щелкните
Далее.
• Путь установки. При необходимости выберите другой путь установки.

Путь установки по умолчанию: C:\Program Files(x86)\Automation Anywhere IQ Bot
 <номер версии>\

IQ Bot A360.21 и далее: C:\Program Files (x86)\Automation 360 IQ Bot\
• Путь вывода. Выберите путь вывода, где будут сохраняться выходные данные. Путем

вывода также может быть общий сетевой путь. Во время повторной установки Путь
вывода автоматически определяется программой установки (на основе данных предыдущей
установки, хранящихся в базе данных конфигурации IQ Bot). При необходимости измените
сведения.
Путь вывода по умолчанию: C:\Users\Public\Documents\Automation Anywhere IQ
 Bot Platform\Output\
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14. В окне Готовность к установке программы проверьте и просмотрите настройки установки и
щелкните Установить, чтобы начать установку.
• При первой установке в процессе установки может появиться оповещение системы

безопасности Microsoft Windows Security с предложением разрешить программе установки
установить Erlang. При появлении такого запроса щелкните Разрешить доступ.

• Иногда окно Оповещение системы безопасности Windows не видно (оно может быть
скрыто за другими активными окнами). С помощью сочетания клавиш Alt + Tab убедитесь,
что окно Оповещение системы безопасности Windows не скрыто за другими видимыми
окнами.

15. Щелкните Разрешить доступ, чтобы завершить установку, а в окне Успешная установка
щелкните Готово.
На рабочем столе создается значок IQ Bot.
Если при запуске IQ Bot возникает ошибка, возможно, придется перезапустить службы Cognitive
Console Automation Anywhere Control Room Reverse Proxy и Automation Anywhere.

16. Для Control Room задайте файл cluster.properties нужным образом в зависимости от
версии выпуска..

Проверьте, что IQ Bot установлен, убедитесь, что службы IQ Bot запущены, используя
API-интерфейсы проверки работоспособности, и зарегистрируйте IQ Bot в Control Room.
Контрольный список после установки

Installing IQ Bot in Cluster mode
Install IQ Bot in Cluster mode for improved throughput. IQ Bot supports clustering of up to five IQ Bot
installations.
Ensure you have a load balancer for a cluster setup to distribute traffic to all application server nodes.
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1. Install IQ Bot on each machine in custom mode.
• During installation, on the Load Balancer Configuration screen, type in the load balancer host

name and port.
• Select the Load Balancer can handle SSL Offloading option, if the load balancer supports is to

enable SSL offloading.
• Provide the shared output path on the Destination Folder screen.
• During installation, use the same database server details on all the nodes.

Установка IQ Bot в пользовательском режиме
2. Share the output folder with the access role Everyone.

См. раздел Make a Shared Folder Accessible.
3. Use Command Prompt to link each machines containing an IQ Bot installation to the primary cluster.

См. раздел RabbitMq cluster configuration for IQ Bot.
4. Необязательно: If you have set up Control Room in High Availability mode, you can set up IQ Bot in

High Availability mode as well.
High Availability and Disaster Recovery overview

5. Configure the firewall to have ports 4369 and 25672 open.
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For each machine containing an IQ Bot installation, verify that IQ Bot is installed, ensure the IQ Bot
services are running using the healthcheck APIs, and register IQ Bot with Control Room. Контрольный
список после установки

Прим.:  When you register each installation of IQ Bot, in the URL field, enter the URL to the load
balancer.

Важное замечание:  In a cluster setup, if a temporary network issue occurs, the cluster breaks. To add
the nodes back into the cluster, you must manually execute commands in each of the participating nodes.
You also have to monitor the cluster status to know if it is healthy or broken. To avoid such issues, you
can configure the cluster to automatically recover (auto-recover) from temporary network issues. See this
article for information about how to enable auto-recovery: RabbitMQ Cluster Configuration with Auto-recovery
(A-People login required).

RabbitMq cluster configuration for IQ Bot
Use the command prompt to configure three clusters.
Complete steps 1 and 2 in Installing IQ Bot in Cluster mode.

1. Open command prompt, navigate to {RabbitMq installation directory}\sbin and execute
the following command: rabbitmqctl.bat cluster_status.
You will see an output similar to this:Cluster status of node rabbit@IQBotCluster1 ...
 [{ nodes, [{ disc, [rabbit @IQBotCluster1] }] }, { running_nodes, [rabbit
 @IQBotCluster1] }, { cluster_name, << "rabbit@IQBotCluster1" >> },
 { partitions, [] }, { alarms, [{ rabbit @IQBotCluster1, [] }] }]

2. Выполните следующую команду: rabbitmqctl list_queues -p test.
3. Configure the primary cluster.

a) In IQBotCluster1 VM, open command prompt and navigate to {IQ Bot Installation
 Directory}\Configurations

b) Выполните следующую команду: messagequeue_cluster_configuration.bat
 “IQBotCluster1”.

4. Link the second cluster to the primary cluster.
a) In IQBotCluster2 VM, open command prompt and navigate to {IQ Bot Installation

 Directory}\Configurations.
b) Выполните следующую команду: messagequeue_cluster_configuration.bat

 “IQBotCluster1”.

5. Verify if the clusters were added successfully.
Open command prompt, navigate to {RabbitMq installation directory}\sbin and execute
the following command: rabbitmqctl.bat cluster_status.
You should see a similar output to the following, confirming that the two clusters were successfully
added: Cluster status of node rabbit @IQBotCluster2...[{ nodes, [{ disc,
 [rabbit @IQBotCluster1, rabbit @IQBotCluster2] }] }, { running_nodes,
 [rabbit @IQBotCluster1, rabbit @IQBotCluster2] }, { cluster_name, <<
 "rabbit@IQBotCluster1" >> }, { partitions, [] }, { alarms, [{ rabbit
 @IQBotCluster1, [] }, { rabbit @IQBotCluster2, [] }] }]
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6. Link the third cluster to the primary cluster.
a) In IQBotCluster3 VM, open command prompt and navigate to {IQ Bot Installation

 Directory}\Configurations.
b) Выполните следующую команду: messagequeue_cluster_configuration.bat

 “IQBotCluster1”.

You should see a similar output to the following, confirming that the third cluster was
successfully added: Cluster status of node rabbit @IQBotCluster3...[{ nodes,
 [{ disc, [rabbit @IQBotCluster1, rabbit @IQBotCluster2, rabbit
 @IQBotCluster3] }] }, { running_nodes, [rabbit @IQBotCluster1,
 rabbit @IQBotCluster2, rabbit @IQBotCluster3] }, { cluster_name, <<
 "rabbit@IQBotCluster1" >> }, { partitions, [] }, { alarms, [{ rabbit
 @IQBotCluster1, [] }, { rabbit @IQBotCluster2, [] }, { rabbit
 @IQBotCluster3, [] }] }]

When you are done linking the clusters, proceed to step 4 in Installing IQ Bot in Cluster mode.

Make a Shared Folder Accessible
Share the output folder with all the devices on the cluster so that when IQ Bot processes documents, the
extracted data is saved to the one output folder.
Follow the steps to make your shared folder accessible to IQ Bot.
1. Change log on of the application services with .\Administrator account on all cluster nodes.
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2. On primary (shared folder) node, change following settings:
a) Click Control Panel > Network and Internet > Network and Sharing Center > Advanced

Sharing Setting
b) Expand Private and click Network Discovery.
c) In Network Discovery:

1. Select Turn on Network Discovery.
2. Check the Turn on automatic setup of network connected devices checkbox.
3. Click File and Printer Sharing and then select the Turn on file and printer sharing

checkbox.

d) Expand Guest or Public and click Network Discovery.
e) In Network Discovery:

1. Select Turn on Network Discovery.
2. Click File and Printer Sharing and then select the Turn on file and printer sharing

checkbox.

Open "Local Group Policy Editor". Go to Local Computer Policy >> Windows Settings >> Security
Settings >> Local Policies >> Security Options. Find "Network access : Sharing and security
model for local accounts". Change it to "Guest only - local users authenticate as Guest".

f) Click Local Group Policy Editor.
g) Click Local Computer Policy > Windows Settings > Security Settings > Local Policies >

Security Options.
h) Find Network access : Sharing and security model for local accounts and change it to

Guest only - local users authenticate as Guest.
i) Execute this Powershell script:

Set-ItemProperty -Path "HKLM:\SYSTEM\CurrentControlSet\Services
\LanmanWorkstation\Parameters" -Name "AllowInsecureGuestAuth" -Type
 DWord -Value 1

You need to execute this Powershell script on every machine which is a part of the cluster.

After you have made the shared folder accessible to every device in the cluster, proceed to step 3 in
Installing IQ Bot in Cluster mode.

Installing IQ Bot in Cluster mode on Amazon EC2
Install IQ Bot in the cluster mode on Amazon Elastic Compute Cloud (Amazon EC2).
If you install IQ Bot in Cluster mode on Amazon EC2, make a note of the following.
• The name for the Amazon EC2 RabbitMQ v3.8.18cluster is in this format: rabbit@ip-XXX-XXX-XX-

XX.
• Connecting to a node works if both the nodes are in the same local network, but if you connect to a

cluster outside the local Amazon EC2 network, configure the host file of node 2.
• Add an entry in the host file where AA.AA.AAA.AAA is the public IP of node 1.

AA.AA.AAA.AAA
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ip-XXX-XX-XX-XX

If all the IQ Bot instances in a cluster are not a part of the same domain, ensure that the following services
are running using the Administrator user login on each instance.
• Automation Anywhere Cognitive Projects
• Automation Anywhere Cognitive Validator
• Automation Anywhere Cognitive File Manager

To run a service using the Administrator user login, do the following procedure.
1. Click Task Manager > Services > Open Services.
2. Right-click the target service, for example, Automation Anywhere Cognitive Projects, and click

Properties.
3. In the Properties dialog box, select This account and enter the credentials for the administrator user.
4. Click OK and restart this service. Repeat these steps for the remaining services on this instance and all

the other IQ Bot instances in the cluster.

Контрольный список после установки
Проверьте, что IQ Bot установлен, убедитесь, что службы IQ Bot запущены, используя
API-интерфейсы проверки работоспособности, и зарегистрируйте IQ Bot в Control Room.

Шаг 1. Проверьте IQ Bot на панели
управления

Убедитесь, что элемент Automation Anywhere
IQ Bot существует в разделе Панель
управления > Программы > Программы
и функции на компьютере, на котором
установлен IQ Bot.

Шаг 2. Убедитесь, что запущены
когнитивные службы Automation Anywhere

Убедитесь, что указанные ниже службы
установлены на компьютере, на котором
установлен IQ Bot, а для статуса служб в окне
служб Microsoft Windows задано значение
Выполняется.
Чтобы просмотреть список служб, которые
запущены в данный момент, откройте
services.msc, используя Пуск > Запустить.
• Automation Anywhere Cognitive Alias
• Automation Anywhere Cognitive Application
• Automation Anywhere Cognitive Classifier

Service
• Automation Anywhere Cognitive Console
• Automation Anywhere Cognitive File Manager
• Automation Anywhere Cognitive Gateway-2
• Automation Anywhere Cognitive MLScheduler

Service

Прим.:  Что касается Сборка 12350, эта
служба по умолчанию отключена.
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• Automation Anywhere Cognitive MLWeb Service

Прим.:  Что касается Сборка 12350,
эта служба использует новую модель
для более эффективного обнаружения
флажков и таблиц. Чтобы вернуться к
предыдущей модели, откройте файл
CognitiveServiceConfiguration.json, найдите
следующий фрагмент кода и измените
значение version на v1:

"MLWebService": {
"port": "9991",
"version": "v2"
}

• Automation Anywhere Cognitive Projects
• Automation Anywhere Cognitive Report
• Automation Anywhere Cognitive Validator
• Automation Anywhere Cognitive Visionbot

Manager
• Automation Anywhere Cognitive VisionbotEngine

Service

Чтобы переустановить службы IQ Bot,
Запустите reinstall-allservices.bat от имени
администратора, используя Каталог установки
IQ Bot > Папка конфигурации. Отобразится
список служб с серийными номерами. Для
переустановки служб выполните одно из
указанных ниже действий.
1. Введите серийный номер службы, которую

требуется переустановить.
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2. Введите серийный номер службы, а затем
имя пользователя и пароль домена.

Шаг 3. Выполните проверку
работоспособности

Для проверки наличия необходимой службы
используйте API проверки работоспособности.
Сведения о запросах/ответах API проверки
работоспособности описаны в приведенной ниже
таблице.
Запросы
В приведенной ниже таблице перечислены
запросы API, отправляемые для проверки
работоспособности различных служб IQ Bot.

Имя службы URL-адрес

Alias http://<hostname/
IP>:9997/
healthcheck

Application
 Service

http://<hostname/
IP>:9002/
healthcheck

Project Service http://<hostname/
IP>:9999/
healthcheck

FileManager
 Service

http://<hostname/
IP>:9996/
healthcheck

Visionbot http://<hostname/
IP>:9998/
healthcheck

Validator Service http://<hostname/
IP>:9995/
healthcheck
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Имя службы URL-адрес

Report Service http://<hostname/
IP>:9992/
healthcheck

Gateway Service http://<hostname/
IP>:8100/
healthcheck

Frontend or
 Console Service

http://<hostname/
IP>:3000/
healthcheck

MLWeb Service http://<hostname/
IP>:9991/
healthcheck

В списке таблиц замените <hostname/IP>
именем/IP-адресом узла IQ Bot, чтобы создать
запрос API проверки работоспособности с
помощью веб-браузера на компьютере, на
котором установлен IQ Bot.
Например, если ваш IQ Bot доступен по адресу
http://localhost:3000, то доступ к FileManager
Healthcheck можно получить по следующему
URL-адресу: http://localhost:9996/
healthcheck.
Ответы
Типичный успешный ответ приведен в
представленном ниже примере кода.
Subsystem

Application: <Service Name>

Status: OK

Application uptime: 0d 3h 45m 6s

Version: 1.2.0-RELEASE

Branch: RC-5.2-1

GIT #:
 d88e59c0435c3a836bb47cd586081205564904c5

Build Time: 2018-02-17T09:26:52.523Z

Dependencies:

Database Connectivity: OK

MessageQueue Connectivity: OK

Project: OK

VisionBot: OK

Значением **<Service Name> могут быть alias,
application, filemanager, project, reports, gateway,
validator или visionbot.
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Dependencies: отображается статус всех
зависимых служб, например базы данных и
очереди сообщений рассматриваемой службы.
Если API-интерфейс выводит ответ Status:
 Not_OK, см. Healthcheck status Not_Ok (A-People
login required).

Шаг 4. Проверьте базу данных Система создает базу данных IQBot.
Выполните вход в базу данных с помощью
<dbusername> и <dbpasswd>, чтобы проверить
имена баз данных и таблиц, используя
<hostname>, <dbusername> и <dbpasswd>.

Шаг 5 (необязательный). Создайте
соответствующие сертификаты и
настройте параметры HTTP и HTTPS

Creating a self-signed certificate with Subject Alternative
Name

Configuring IQ Bot with HTTP and HTTPS

Шаг 6. Регистрация Чтобы начать использовать IQ Bot, необходимо
зарегистрировать IQ Bot в Control Room.
Registering IQ Bot with the Control Room

Если регистрация не удалась
Чтобы решить проблему, выполните действия,
описанные на представленных ниже страницах.
1. Unregistering IQ Bot from the Control Room

2. Resolving IQ Bot registration failure

Далее: Установите модуль OCR (необязательно):
Во время установки IQ Bot система в качестве
модуля Распознавание текста (OCR) по
умолчанию устанавливает последнюю версию
Tesseract Optical Character Reader. Чтобы
использовать другой модуль, выполните
действия, указанные по соответствующей
ссылке:
Use Microsoft Azure Computer Vision OCR engine

Use ABBYY FineReader Engine Распознавание
текста (OCR) engine in IQ Bot

Use Google Vision API OCR engine

Использование модуля Распознавание текста
(OCR) Tegaki API

Войдите в систему и настройте Control
Room:создайте и зарегистрируйте конкретных
пользователей IQ Bot в Control Room. Learn more
about IQ Bot roles and access permissions: IQ Bot
user personas and roles

Понятия, связанные с данным
Install and update Automation 360 IQ Bot
This collection of topics guide you through the process of installing or setting up Automation 360 IQ Bot
On-Premises and Cloud.

© 2023 Automation Anywhere. All rights reserved.     1099

https://apeople.automationanywhere.com/s/article/After-the-IQBot-installation-the-Health-check-status-shows-Not-Ok
https://apeople.automationanywhere.com/s/article/After-the-IQBot-installation-the-Health-check-status-shows-Not-Ok


    Automation Anywhere - Install and update Automation 360

Creating a self-signed certificate with Subject Alternative Name
Create a self-signed certificate with Subject Alternative Name (SAN) when you want to use an SSL
certificate for multiple domains.
1. Create a file with the name domain.cnf and add the following configuration as per your

requirement:
[req]

default_bits = 2048

prompt = no

default_md = sha256

x509_extensions = v3_req

distinguished_name = dn

[dn]

C = ES

ST = MyState

L = MyCity

O = MyOrg

emailAddress = email@mydomain.com (Any email address)

CN = sss-laptop136.aaspl-brd.com (CR FQDN Url Name)

[v3_req]

subjectAltName = @alt_names

[alt_names]

DNS.1 = sss-laptop136.aaspl-brd.com (CR FQDN Url Name)

DNS.2 = sss-laptop151.aaspl-brd.com (IQBOT URL FQDN Name)

2. Download the Openssl utility.
3. Create the certificate either on Microsoft Windows or on Linux:

• Run the following command to create the certificate on Microsoft Windows:

openssl.exe req -new -x509 -newkey rsa:2048 -sha256 -nodes -keyout
"D:\ssc\ssc\key.key" -days 3560 -out "D:\ssc\ssc\cert.crt" -config
"D:\ssc\ssc\domain.cnf"

• Run the following command to create the certificate on Linux:

openssl req -new -x509 -newkey rsa:2048 -sha256 -nodes -keyout /tmp/
cert/key.key -days 3560
-out /tmp/cert/cert.crt -config /tmp/cert/domain.cnf

4. Create the .pfx file from cert and key file:
• Run the following command to create the .pfx file from the cert and key file on Microsoft

Windows:

openssl.exe pkcs12 -export -out "D:\ssc\ssc\sss-aspl.pfx" -inkey "D:
\ssc\ssc\key.key"
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-in "D:\ssc\ssc\cert.crt"

• Run the following command to create the .pfx file from the cert and key file on Linux:

openssl.exe pkcs12 -export -out /tmp/cert/sss-aspl.pfx -inkey /tmp/
cert/key.key -in
/tmp/cert/cert.crt"

5. Import the .pfx file in Microsoft IIS.
Use the same .pfx file with the installation of IQ Bot.

6. Run the following command to import the certificate in the Java keystore:

keytool.exe -import -alias dev -keystore "C:\Program Files
(x86)\Java\jre1.8.0_91\lib\security\cacerts" -file "D:\cert\xyz.com.crt"

Based on the type of operating system 32-bit / 64-bit, this C:\Program Files (x86)\Java
\jre1.8.0_91\lib\security\cacerts directory can differ.
If the certificate is not imported in the Java keystore, then Control Room shows the following error
message: Java security certificate path validator signature check failed.

7. Go to %installation_dir%\Configurations and run stopanduninstallallservices.bat
as an administrator.

8. Go to %installation_dir%\Configurations and run installandstartervices.bat as an
administrator.

9. Import the cert.crt file to the Trusted Root using the Microsoft Management Console (MMC).

Понятия, связанные с данным
Install and update Automation 360 IQ Bot
This collection of topics guide you through the process of installing or setting up Automation 360 IQ Bot
On-Premises and Cloud.

Registering IQ Bot with the Control Room
IQ Bot is integrated with Control Room for user management. Log in to the Control Room and register IQ
Bot.
Do the following before registering IQ Bot with Control Room:
• Launch the Control Room and create an admin user.
• Install the license for IQ Bot. См. раздел Configure new licenses.

IQ Bot can be accessed after registering it with Control Room.

Прим.:  Make a note of the database credentials used for the Control Room installation. This is required
for IQ Bot installation if you are using the same database.

1. Log in to Control Room as an administrator.
If you already logged into Control Room in the same browser session, you are automatically logged in
to IQ Bot.

2. Click Administration > Settings > IQ Bot.
3. Click Edit in the IQ Bot section, and a text box appears.
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4. Enter the correct IQ Bot URL for example, http(s)://IQBotURL/, and click Save changes.
If the application registration fails, try registering again.

Прим.:  The URL https://{CR_URL}/IQBot/ is case-sensitive. For example, ensure that the URL
mentions "IQBot" and not "IQbot".

Configuring IQ Bot with HTTP and HTTPS
This section describes single and multiple domain scenarios when installing IQ Bot and Control Room with
various server certificates.
There are two main scenarios:
• Installing IQ Bot and Control Room with wildcard server certificates (single domain).
• Installing IQ Bot and Control Room with individual server certificates (different domains).

You can encrypt the communication between IQ Bot and Control Room by configuring Two-way (Mutual)
SSL. The following steps explain how to configure this and can be achieved by exchanging the SSL
certificates between IQ Bot and the Control Room.

Прим.:  IQ Bot does not support self-signed certificate.

Prerequisite for single domain
If Control Room and IQ Bot are on a single domain, and we name the domain as DomainOne, the following
certificate files are required:
• PFX file:

Ensure you have the DomainOne.pfx file. The file size is approximately 7/8 KB. One pfx file is
required for a single domain.

• CA Bundled certificate from the Enterprise Control Room (with all intermediate certificate
information):
Use any tool to create the bundle certificate, or you can use openssl to create CA/bundled certificate
from DomainOne.pfx file.
Use the following example command to create CA/Bundled certificate using openssl for
DomainOne.pfx:

openssl.exe pkcs12 -in "{DomainOne.pfx file location}" -cacerts -nokeys -
chain -out "
{Outputlocation}\DomainOne_ControlRoom_CA.crt

Прим.:  You will need the Control Room bundle certificate for single or multiple domains.

• Public certificates from IQ Bot and Control Room:
Use any tool to create the public certificates or use openssl to create Public certificate from the
DomainOne.pfx file.
Use the following example command to create the Public certificate using openssl for DomainOne.pfx:

openssl.exe pkcs12 -in "{DomainOne.pfx file location}" -clcerts -nokeys -
out
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"{Outputlocation}\DomainOne_ControlRoom_PublicCertificate.crt

Прим.:  For a single domain, there will be one public certificate for both, IQ Bot and Control Room.

Prerequisite for multiple domains
If the Control Room and IQ Bot are on separate domains, and the domain names are DomainOne (Control
Room) and DomainTwo (IQ Bot), the following certificate files are required:
• Pfx file:

Ensure you have the DomainOne.pfx and DomainTwo.pfx files. The file size is approximately 7/8
KB.

• Public certificates from IQ Bot and Control Room:
Use any tool to create the bundle certificate or use openssl to create Public certificate from
DomainTwo.pfx file.
Use the following example command to create the Public certificate using openssl for DomainTwo.pfx:

openssl.exe pkcs12 -in "{DomainTwo.pfx file location}" -clcerts -nokeys -
out
"{Outputlocation}\DomainTwo_IQBot_PublicCertificate.crt

Прим.:  : If you set up Control Room or IQ Bot with HTTPS, then configure IQ Bot with HTTPS before
registering.

Configuring IQ Bot with HTTPS when Control Room is configured with HTTP
Configure IQ Bot with HTTPS when Control Room is configured with HTTP.
1. Set up IQ Bot using the PFX file with HTTPS configuration during installation.
2. Put the bundled certificate (DomainTwo_IQBot_CA.crt) for Control Room in the IQ Bot folder, after

IQ Bot installation at C: \Program Files (x86)\Automation Anywhere IQ Bot\Portal
\keys. Rename the DomainTwo_IQBot_CA.crt to ca.crt.

Важное замечание:  If the ca.crt file in the C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version number>\Portal\keys folder is already present, then replace it
with the new ca.crt file.

3. Add the IQ Bot Public certificate (DomainTwo_IQBot_PublicCertificate.crt) to the keystore for the
Control Room by running the following command as a system administrator:

"{Control Room installation directory}\JRE\bin\java.exe" -jar certmgr.jar
 -appDir "{Control Room
installation directory}" -importTrustCert "{FolderLocation}/
DomainTwo_IQBot_PublicCertificate.crt" 

Configuring IQ Bot with HTTP when Control Room is configured with HTTPS
Configure IQ Bot with HTTP and HTTPS to access IQ Bot using HTTPS and HTTP in the IQ Bot URL.
1. Put the bundled certificate (DomainOne_ControlRoom_CA.crt) for Control Room in the IQ Bot folder

after IQ Bot installation at C: \Program Files (x86)\Automation Anywhere IQ Bot
\Portal\keys. Rename the ControlRoom_CA.crt to ca.crt.
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Важное замечание:  If the ca.crt file in the C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version number>\Portal\keys folder is already present, then replace it
with the new ca.crt file.

2. Add the Control Room public certificate (DomainOne_ControlRoom_PublicCertificate.crt) to the
keystore for IQ Bot by running this command as a system administrator:

"{IQ Bot installation directory}\JRE\zulu8.40.0.20-sa-fx-jre8.0.222-
win_x64\bin\keytool.exe" -import -
alias cr -keystore "{IQ Bot installation directory}\JRE\zulu8.40.0.20-sa-
fx-jre8.0.222-
in_x64\lib\security\cacerts" -file "{FolderLocation}/
 DomainOne_ControlRoom_PublicCertificate.crt "

The system will ask for a keystore password, which is changeit.

Прим.:  Sometimes the system shows a message saying cr exists. In this case, change cr in the
command to cr1 or something else.

Configuring IQ Bot with HTTPS using single domain
Configure IQ Bot with HTTPS when Control Room is configured with HTTPS using single domain.
1. Set up IQ Bot using the PFX file with HTTPS configuration during installation.
2. Put the bundled certificate (DomainOne_ControlRoom_CA.crt) for Control Room in the IQ Bot folder

after IQ Bot installation at C:\Program Files (x86)\Automation Anywhere IQ Bot
 <version number>\Portal\keys. Rename the DomainOne ControlRoom_CA.crt to
ca.crt.

Важное замечание:
If the ca.crt file in the C:\Program Files (x86)\Automation Anywhere IQ Bot
 <version number>\Portal\keys folder is already present, then replace it with the new ca.crt
file.

3. Add the Control Room public certificate (DomainOne_ControlRoom_PublicCertificate.crt) to the
keystore for IQ Bot by running this command as a system administrator:

"{IQ Bot installation directory}\JRE\zulu8.40.0.20-sa-fx-jre8.0.222-
win_x64\bin\keytool.exe"
-import -alias cr -keystore "{IQ Bot installation directory}\JRE
\zulu8.40.0.20-sa-fx-jre8.0.222-
win_x64\lib\security\cacerts" -file "{FolderLocation}/
 DomainOne_ControlRoom_PublicCertificate.crt "

.
The system will ask for a keystore password, which is changeit.

Прим.:  Sometimes the system shows a message saying cr exists. In this case, change cr in the
command to cr1 or something else.

Понятия, связанные с данным
Naming guidelines for Control Room URLs
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Adhere to Domain Name System (DNS) guidelines when you configure domain and subdomain Control
Room URLs for On-Premises and Cloud deployments.

ConfiguringIQ Bot with HTTPS using multiple domains
Configure IQ Bot with HTTPS when Control Room is configured with HTTP using multiple domains.
1. Set up IQ Bot using the PFX file with the HTTPS configuration during installation.
2. Put the bundled certificate (DomainOne_ControlRoom_CA.crt) for the Control Room in the IQ Bot

folder after IQ Bot installation at: C: \Program Files (x86)\Automation Anywhere IQ Bot
\Portal\keys.
Rename the DomainOne ControlRoom_CA.crt to ca.crt.

Важное замечание:  If the ca.crt file in the C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version number>\Portal\keys folder is already present, then replace it
with the new ca.crt file.

3. Add the Control Room public certificate (DomainOne_ControlRoom_PublicCertificate.crt) to the
keystore for IQ Bot by running this command as a system administrator:

"{IQ Bot installation directory}\JRE\zulu8.40.0.20-sa-fx-jre8.0.222-
win_x64\bin\keytool.exe" -import -
alias cr -keystore "{IQ Bot installation directory}\JRE\zulu8.40.0.20-sa-
fx-jre8.0.222-
in_x64\lib\security\cacerts" -file "{FolderLocation}/
 DomainOne_ControlRoom_PublicCertificate.crt "

The system will ask for a keystore password, which is changeit.

Прим.:  Sometimes the system shows a message saying cr exists. In this case, change cr in the
command to cr1 or something else.

4. Add the IQ Bot Public certificate (DomainTwo_IQBot_PublicCertificate.crt) to the keystore for the
Control Room by running the following command as a system administrator:

"{Control Room installation directory}\JRE\bin\java.exe" -jar certmgr.jar
 -appDir "{Control Room 
installation directory}" -importTrustCert "{FolderLocation}/
DomainTwo_IQBot_PublicCertificate.crt"

Прим.:  For Automation 360 IQ Bot (Build 550), change JRE to jrk in the command mentioned above.

5. Next, restart the machine(s) and follow instructions to register IQ Bot.
См. Registering IQ Bot with the Control Room

Use Microsoft Azure Computer Vision OCR engine
Microsoft Azure Computer Vision OCR engine is a cloud Распознавание текста (OCR) engine and
is available to all customers of IQ Bot. IQ Bot automates some installation steps for Microsoft Azure
Computer Vision OCR engine.
When you process documents using the Microsoft Azure Computer Vision OCR engine, data is removed
immediately. Microsoft Azure Computer Vision OCR engine provides approximately 18% STP and 80%
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accuracy with data extraction. For more information on privacy for data retention, see Microsoft Azure
Cognitive Services.

Прим.:  IQ Bot also supports containerized deployment of Microsoft Azure Computer Vision OCR engine:
Configure IQ Bot using Docker container and Azure OCR (A-People login required)

When creating a learning instance, you can select any language from the Primary language of
documents drop-down menu. During processing, the Распознавание текста (OCR) engine tries to auto-
detect the primary language and can override your selection. For example, you can specify English, but if
you upload a Spanish document, the API will try to process the Spanish language.

Совет:  You can troubleshoot any issues with extracting data from low quality or handwritten documents
IQ Bot unable to extract data from low quality and Handwritten documents (A-People login required)

Follow the steps to configure the Settings.txt file and use Microsoft Azure Computer Vision OCR
engine.

Важное замечание:  Configuring the settings.txt file is not applicable to Automation 360 IQ Bot
Cloud

1. Ensure your IQ Bot server has internet connectivity and external DNS resolution.
Check to enable communication for the API endpoint on default port = 443: default endpoint =
 https://aai-iq-bot-ocr.cognitiveservices.azure.com/.

Прим.:  To validate connectivity to the API endpoint and the server, open a web browser on the
server and type in the complete URL for the API endpoint. If the browser returns a 404 error, then it
implies that a response from the API endpoint was received.

2. You can use your own Microsoft Azure Computer Vision OCR engine subscription or spell-check keys.
See Use your own keys for Microsoft Azure Computer Vision OCR engine for more information.

3. Необязательно: From the C:\Program Files (x86)\Automation 360 IQ Bot
 <version number>\Configurations folder, open the Settings.txt file, and change the
Распознавание текста (OCR) engine value to OCREngine=Tesseract4 or OCREngine=Abbyy to
OCREngine=MicrosoftAzureAPI. Then save the file.

4. Run the stopanduninstallallservices.bat file at C:\Program Files (x86)\Automation 360
 IQ Bot\Configurations.
After stopping the services, run installandstartallservices.bat file to install and start the services.

5. Create learning instances in IQ Bot, and use Microsoft Azure Computer Vision OCR engine for the text
segmentation, and Распознавание текста (OCR) engine for these learning instances.
For these learning instances, you can continue to use the IQ Bot capabilities for document
classification, auto-mapped fields, cognitive extraction, and field value auto-correction.

List of service URLs used for Microsoft Azure Computer Vision OCR engine (optional)
• https://aai-iq-bot-ocr.cognitiveservices.azure.com/
• https://aai-iq-bot-ocr-spellcheck.cognitiveservices.azure.com/

Прим.:  All URLs point to a global service region in United States.

If IQ Bot is unable to process a document using Microsoft Azure Computer Vision OCR engine, you can
review the troubleshooting tips.
IQ Bot unable to process the document with Microsoft Azure OCR (A-People login required)
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Use your own keys for Microsoft Azure Computer Vision OCR engine
You can use your own Microsoft Azure Computer Vision OCR engine subscription or Spell Check keys.
Users can use a combination of their own Microsoft Azure Computer Vision OCR engine keys with the Spell
Check keys provided by Automation Anywhere. Using the provided Spell Check keys from Automation
Anywhere will send your data to the Automation Anywhere account. If you do not want to send any
data to the Automation Anywhere Microsoft Azure account, you would have to provide your own Spell
Check service keys, or turn it off by setting the value in the AzureOCREngineSettings.json file to
EnableAutoCorrectSegmentText: false.
Follow the steps to use your own keys for Microsoft Azure Computer Vision OCR engine.
1. By default, IQ Bot's encrypted Microsoft Azure Computer Vision OCR engine subscription and

Spell Check keys are used. If you prefer to use your own Microsoft Azure Computer Vision OCR
engine subscription and, or Spell Check keys, go to C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version>\Configurationsand folder Configurations >
AzureOCREngineSettings.json file, and specify your keys.
If both SubscriptionKey and SubscriptionClientKey are specified, then
SubscriptionClientKey is used:
• VisionSubscriptionKey
• VisionSubscriptionClientKey
• SpellCheckSubscriptionKey
• SpellCheckSubscriptionClientKey

2. Enter your keys correctly to ensure proper API calls as follows:
Before:

{
  "VisionServiceUrl": "https://aai-iq-bot-
ocr.cognitiveservices.azure.com/",
  "EngineType": 0,
  "VisionSubscriptionKey": "",
  "VisionSubscriptionClientKey": "",
  "SpellCheckSubscriptionKey": "",
  "SpellCheckSubscriptionClientKey": "",
  "EnableDebugging": false,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation Anywhere
 IQBot Platform\\Output\\Engine\\Azure",
  "HttpTimeoutInSec": 300,
  "EnableReprocessLowConfidentSegment": true,
  "EnableAutoCorrectSegmentText": true,
  "EnableResolveOverlappedSegment": true,
  "EnableFieldMerging": true,
  "EnableFieldRegions": true
}

After:

{
  "VisionServiceUrl": "https://aai-iq-bot-
ocr.cognitiveservices.azure.com/",
  "EngineType": 0,
  "VisionSubscriptionKey": "",
  "VisionSubscriptionClientKey": "191234d5e7abc1f382123459d4399e33",
  "SpellCheckSubscriptionKey": "",
  "SpellCheckSubscriptionClientKey": "336f8f6a503a4c30ba123456834d4abc",
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  "EnableDebugging": false,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation Anywhere
 IQBot Platform\\Output\\Engine\\Azure",
  "HttpTimeoutInSec": 300,
  "EnableReprocessLowConfidentSegment": true,
  "EnableAutoCorrectSegmentText": true,
  "EnableResolveOverlappedSegment": true,
  "EnableFieldMerging": true,
  "EnableFieldRegions": true
}

3. Run the stopanduninstallallservices.bat file as an administrator. The default location
of the file is at C:\Program Files (x86)\Automation Anywhere IQ Bot <version>
\Configurations.

4. Run the installandstartallservices.bat file as an administrator. The default location
of the file is at C:\Program Files (x86)\Automation Anywhere IQ Bot <version>
\Configurations .
Log in or refresh your IQ Bot web page.

Use ABBYY FineReader Engine Распознавание текста (OCR) engine in IQ
Bot
IQ Bot supports ABBYY FineReader Engine version 12.2, 12.3, and 12.4.
When installing IQ Bot, the system automatically installs an ABBYY FineReader Engine open run-time
license on your server.

Прим.:  If you have completed the steps to upgrade IQ Bot, you must update the folder path to the
AbbyyOCREngineSettings.json configuration file.

Use the following steps to manually install ABBYY FineReader Engine:
1. Download the OCR plug-in with IQ Bot.
2. Unzip the OCR plug-in folder in your downloads folder, and place that unzipped folder, at <IQ Bot

 Installation Path>\Automation 360 IQ Bot\.
3. Ensure the folder says <IQ Bot Installation Path>\Automation 360 IQ Bot\OCR

 Plugins\ABBYY SDK\12\FineReader Engine. . ., and the unzipping does not create OCR
 Plugins\OCR Plugins twice. After you unzip the downloaded file, make sure to keep the folder
name as OCR Plugins, and remove the version number. Пример. If the unzipped folder name is OCR
 Plugins 12.4, remove the version number (12.4) from the end of the folder name.

4. To use ABBYY FineReader Engine with IQ Bot you have the following options:
Параметры Описание

Set ABBYY FineReader Engine as your
default Распознавание текста (OCR)
engine

Configure the Settings.txt file.
Follow steps 5 and 6 to configure the
Settings.txt file.

Важное замечание:  Configuring the
settings.txt file is not applicable to
Automation 360 IQ Bot Cloud

Select ABBYY FineReader Engine
Распознавание текста (OCR) engine from
the UI

To select from the UI, see Select an
Распознавание текста (OCR) engine.
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5. Важное замечание:  Configuring the settings.txt file is not applicable to Automation 360 IQ
Bot Cloud.
In Automation 360 IQ Bot Cloud, you can use the appConfigurations API to read and update the
OCR settings.
For help with using the API, contact the Support team. Open a support case (A-People login required)

To set ABBYY FineReader Engine as your default Распознавание текста (OCR) engine, from the C:
\Program Files (x86)\Automation 360 IQ Bot <version>\Configurations folder,
open the Settings.txt file, change OCREngine=Tesseract4 to OCREngine=Abbyy, and save the file.

Важное замечание:  Troubleshoot classification issue in processing Chinese language documents:
All files are getting unclassified while processing Chinese language documents (A-People login required)

6. Next, run the stopanduninstallallservices.bat file at C:\Program Files (x86)\Automation
 360 IQ Bot\Configurations.

Прим.:  After stopping the services, run installandstartallservices.bat file to install and start the
services.

7. Create learning instances in IQ Bot, and use ABBYY FineReader Engine for the text segmentation
and Распознавание текста (OCR) engine for these learning instances. At the same time, for these
learning instances you still partner with the IQ Bot capabilities on document classification, auto-
mapped fields, cognitive extraction, and field value autocorrection.

Прим.:  If you install IQ Bot in a different folder besides C:\Program Files
 (x86)\Automation 360 IQ Bot <version>, find and open the Configurations >
ABBYYOCREngineSettings.json folder, and update the embedded EnginePath and LicensePath to
match the different folder.

Пример.

{
  "UseOpenRuntimeLicense": true,
  "EnginePath": "C:\\Program Files (x86)\\Automation 360 IQ Bot\\OCR
 Plugins\\ABBYY SDK\\12\\FineReader Engine\\Bin",
  "DeveloperSN": "",
  "ProjectId": "",
  "LicensePath": "C:\\Program Files (x86)\\Automation 360 IQ Bot\
\Configurations\\Runtime.ABBYY.LocalLicense",
  "LicensePassword": ""
}

Прим.:  Sometimes, documents can fail to classify with ABBYY FineReader Engine as your default
Распознавание текста (OCR) engine. See recommended workaround for this issue.
Document uploads are moving to unclassified state while using Abbyy OCR engine (A-People login required)
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8. The following table lists the various ABBYY FineReader Engine versions that are supported and
compatible with IQ Bot:

Таблица 2. Version compatibility matrix of ABBYY FineReader Engine and IQ Bot

Версия ABBYY FineReader Engine Версия IQ Bot

12,2 (A2019.12) and below

12.2 and 12.3 (A2019.13) to (A2019.16)

12.2, 12.3, and 12.4 (A2019.17) and later

Use your own ABBYY FineReader Engine license
Follow the steps to use your own ABBYY FineReader Engine license.

1. Navigate to the IQ Bot installation directory > configuration folder, and open
AbbyyOCREngineSettings.json to update the following properties:
• Change the EnginePath and paste the installed ABBYY FineReader Engine engine path. For

example, C:\\Program Files\\ABBYY SDK\\12\\FineReader Engine\\Bin. Ensure the
path includes separators as two backward slashes. Update the DeveloperSN property with the
license key.

• Update the ProjectId property with your license project ID.
• Update the UseOpenRuntimeLicense to false.

2. From the C:\Program Files (x86)\Automation Anywhere IQ Bot <version>
\Configurations folder, open the Settings.txt file to ensure or modify OCREngine=ABBYY
FineReader Engine, and save the file.

3. Run the stopanduninstallallservices file at C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version>\Configurations.

4. Run the installandstartallservices file and log in to or refresh your IQ Botweb page.

Installation steps if ABBYY FineReader Engine remains installed from a previous IQ
Bot version
If ABBYY FineReader Engine remains installed from a previous IQ Bot version, use the IQ Bot ABBYY
FineReader Engine open run-time license.

1. Navigate to the IQ Bot installation directory > configuration folder, and open the
AbbyyOCREngineSettings.json file to update the following properties:
Change the EnginePath and paste the installed ABBYY FineReader Engine engine path. For example,
C:\\Program Files\\ABBYY SDK\\12\\FineReader Engine\\Bin. Ensure the path includes
separators as two backward slashes.

2. Go to the ABBYY FineReader Engine installation directory, open the Bin folder, and remove the
Protection.Developer.dll file.

3. From the C:\Program Files (x86)\Automation Anywhere IQ Bot <version>
\Configurations folder, open the Settings.txt file, modify or ensure OCREngine=ABBYY
FineReader Engine, and save the file.

4. Run the stopanduninstallallservices file at C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version>\Configurations.

5. Run the installandstartallservices file and log in, or refresh your IQ Bot web page.
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Use Google Vision API OCR engine
Use the Google Vision API Распознавание текста (OCR) engine with IQ Bot to improve the accuracy of
the optical character recognition (Распознавание текста (OCR)) results for training documents in Asian
languages, particularly in Japanese and Korean.  Google Vision API Распознавание текста (OCR) engine in
IQ Bot supports all languages supported by the engine.
Verify that the default port 443 is available to enable communication for the API endpoint using TCP.

Прим.:  See a list of allowed service URLs for using Google Vision API in the example section below.

Google Vision API files are installed on your machine automatically during the IQ Bot installation and is
provided as a built-in plug-in, with a single-step installation, and is available for all users:
• It is a cloud Распознавание текста (OCR) engine.
• Google Vision API does not support documents with more than one language. Before using this feature,

ensure you want to primarily extract Japanese or Korean text only.
• Languages that are written right to left, rather than left to right, are not supported within IQ Bot for

document extraction. For example, Arabic, Aramaic, Azeri, Divehi, Fula, Hebrew, Kurdish, N'ko, Persian,
Rohingya, Syriac, and Urdu.
Prior to this release, the engine primarily supported data extraction for Japanese and Korean text only.
Languages supported in Automation 360 IQ Bot

• Data is not stored in Google Cloud and is removed immediately.
For additional information on privacy for data retention see: Google Data Usage

IQ Bot provides you with the license to use the Google Vision API Распознавание текста (OCR) engine.
You can also use your own license key.
Use your own license keys for Google Vision API OCR engine

Прим.:  Updates to Google Vision API such as Распознавание текста (OCR) engine improvements,
enhancements, and bug fixes might affect content extraction when you use this Распознавание текста
(OCR) engine in IQ Bot. Therefore, we recommend that you periodically refer to the Google Vision API
release notes for the latest updates.
См. раздел Potential impact of Google Vision API OCR upgrade.

You have the following options for using this Распознавание текста (OCR) engine:

Параметры Описание

Вариант 1. Set Google Vision API as your
default engine

Configure the Settings.txt file.

Ограничение:  Configuring the
settings.txt file is not applicable to
Automation 360 IQ Bot Cloud

Вариант 2. Select Google Vision API engine
directly from the UI when creating a learning
instance

Select an Распознавание текста (OCR) engine

© 2023 Automation Anywhere. All rights reserved.     1111

https://cloud.google.com/vision/docs/data-usage


    Automation Anywhere - Install and update Automation 360

To set Google Vision API as your default Распознавание текста (OCR) engine, configure the
Settings.txt file as follows:

Ограничение:  Configuring the settings.txt file is not applicable to Automation 360 IQ Bot Cloud

1. Запустите установщик IQ Bot.
2. Необязательно: Set Google Vision API as the default OCR for new learning instances.

Перейдите к ..\Automation 360 IQ Bot\Configurations\Settings.txt и измените
следующее значение: OCREngine=GoogleVisionAPI.
This will set Google Vision API Распознавание текста (OCR) engine as the default engine for your
environment.

3. The GoogleOCREngineSettings.json file is generated within the ..\Automation 360 IQ
 Bot\Configurations folder with default values as follows:
Use the following with Google Vision API:

{
  "ADCJson": null,
  "EngineType": 2,
  "EnableFieldMerging": true,
  "EnableFieldRegions": true,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation 360 IQBot
 Platform\\Logs\\Engine\\Google"
 }

4. For Japanese and Korean language documents, update the field: "EnableCustomParse": true.

Прим.:  A service restart is not required after making the change.

List of service URLs used for Google Vision API (optional)
Use the following allowed URLs if required:

Прим.:  All URLs point to a global service region in the US.

• API URL: https://vision.googleapis.com/
• Auth URL: https://accounts.google.com/o/oauth2/auth
• Token URL: https://oauth2.googleapis.com/token
• Auth Provider URL: https://www.googleapis.com/oauth2/v1/certs
• Client Auth URL: https://www.googleapis.com/robot/v1/metadata/x509

1. Создайте новый обучаемый экземпляр с использованием документа на одном из азиатских
языков, который вы хотите обучить.

2. Обучите документ и переведите обучаемый экземпляр в рабочий режим.
3. Отправьте файлы на азиатском языке и запустите бот.
4. Выполните загрузку и просмотрите точность результатов извлечения.

Use your own license keys for Google Vision API OCR engine
You can use your own keys for Google Vision API OCR engine subscription.

© 2023 Automation Anywhere. All rights reserved.     1112



    Automation Anywhere - Install and update Automation 360

Users can use their own authentication of Google Vision API. They would need to create Google Cloud
Application Default Credentials (ADC) and copy the content from ADC JSON file to the "ADCJson" field in
GoogleVisionOCREngineSettings.json..

Прим.:  Use the link to create Google Cloud Application Default Credentials for Google Vision API: https://
cloud.google.com/docs/authentication/production.

Follow the steps to use your own keys for Google Vision API OCR engine.
1. By default, IQ Bot's encrypted Google Vision API subscription keys are used. If you prefer to use

your own Google Vision API subscription keys, go to C:\Program Files (x86)\Automation
 Anywhere IQ Bot <version>\Configurations, and folder Configurations >
GoogleVisionOCREngineSettings.json file, and specify your keys.

2. IQ Bot provides you with an inbuilt license for Google Vision API, but you have the option to overwrite
this license if you would like to use your own. Copy the content from the ADC JSON file correctly to
ensure proper API calls as follows:

{
  "ADCJson": {
    "type": "service_account",
    "project_id": "dark-caldron",
    "private_key_id": "9e83979f61cff072d0e0e4f91bf837e6e29bbb",
    "private_key": "-----BEGIN PRIVATE KEY-----\nMIIEvgIBADANBg......----
END PRIVATE KEY-----\n",
    "client_email": "vision-test@dark-caldron.iam.gserviceaccount.com",
    "client_id": "105342202023265468399",
    "auth_uri": "https://accounts.google.com/o/oauth2/auth",
    "token_uri": "https://oauth2.googleapis.com/token",
    "auth_provider_x509_cert_url": "https://www.googleapis.com/oauth2/v1/
certs",
    "client_x509_cert_url": "https://www.googleapis.com/robot/v1/
metadata/x509/vision-test%40dark-caldron-254807.iam.gserviceaccount.com"
  },
  "EngineType": 2,
  "EnableDebugging": false,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation Anywhere
 IQBot Platform\\Logs\\Engine\\Google",
  "HttpTimeoutInSec": 300,
  "EnableCustomParse": false,
  "DistanceThreshold": 15
}

Potential impact of Google Vision API OCR upgrade
Google Vision API OCR is Cloud based, and typically, it is upgraded to a newer version according to
Google's release cycle. As a result of this upgrade, an impact might be observed on document extraction
processing and extraction results in IQ Bot.

Impact on document classification in IQ Bot after the update of Google Vision
API OCR

The classification of documents is based on the OCR result, particularly the order in which the fields
are detected. Thus, if the content of the OCR results varies, then the classification results of the similar
document processed previously might show visible differences during document extraction.
The auto-upgrade affects the classifier service in two ways:
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• Different groups are assigned to documents: The documents when processed will be assigned to
different groups versus what they were originally routed to so far. Consequently, some data extractions
might fail, which were previously successful.

• New groups are created: The documents previously being processed with a group might now result
in new group being created.

Impact on data extraction in IQ Bot after update of Google Vision API OCR

A change in OCR output might result in the following differences during data extraction from a similar
document type:
• Improvement in character recognition and its associated impact: As a result of improved

keyword character recognition, previously unrecognized values from a document will now provide better
extraction results.

Прим.:  If any processing logic is written to fix the lack of detected characters, it might cause issues
when the document is processed.

• Degradation in character recognition and its impact: Validation might fail due to degradation in
OCR output, and the document will be routed to the Validator. In a scenario where there is no validation
setup, the extracted data output might see a degradation.

Options to mitigate

If you encounter any of the previously mentioned issues, you have the following options to explore:
• Retrain existing learning instance to fix issues with document classification.
• Write processing logic using Python to mitigate extraction outcomes.
• Evaluate creating learning instance with different OCR provider supported by IQ Bot.
• Raise a support ticket with Automation Anywhere.

Использование модуля Распознавание текста (OCR) Tegaki API
Используйте модуль Распознавание текста (OCR) Tegaki API с IQ Bot для повышения точности
результатов распознавания текста (OCR), которое используется для обучения документов на
японском и корейском языках. Его можно настроить для использования с On-Premises Automation 360
IQ Bot.
Просмотрите указанные ниже предварительные условия для настройки модуля Распознавание
текста (OCR) Tegaki API.
• Поддержку Распознавание текста (OCR) Tegaki API обеспечивает только On-Premises Automation

360 IQ Bot.
• У вас должен быть выделенный сервер, отвечающий требованиям, установленным Cogent Labs.

Для получения дополнительной информации обратитесь к своему менеджеру-консультанту.
• IQ Bot предоставляет Tegaki API в качестве встроенного подключаемого модуля. Установите

Tegaki API в качестве модуля Распознавание текста (OCR) в файле settings.txt, находящемся
в следующей папке:
C:\Program Files (x86)\Automation 360 IQ Bot <version>\Configurations

• Set the communication for the API endpoint on default port = 443, using TCP protocol.
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Важное замечание:  Недоступно в Cloud Automation 360 IQ Bot.

Распознавание текста (OCR) Tegaki API поддерживает документы на указанных ниже языках.
• Японский
• Корейский
• Японский-английский
• Корейский-английский

1. Запустите установщик IQ Bot.
2. Настройте модуль Распознавание текста (OCR) Tegaki API для версии On-Premises на своем

компьютере на основе инструкций, полученных от вашего представителя Automation Anywhere.
3. Введите свой лицензионный ключ в файл Tegaki OCR settings.json.

Поскольку IQ Bot не предоставляет вам лицензию на использование модуля Распознавание
текста (OCR) Tegaki API, вы должны использовать свой собственный лицензионный ключ.
Выполните указанные ниже шаги для установки собственного лицензионного ключа.
a. Перейдите в следующее местоположение:

C:\Program Files (x86)\Automation 360 IQ Bot\Configurations

b. Настройте конечную точку Tegaki API, на которой установлена версия On-Premises. Set
APIKey = <your key here> and configure the TegakiOCREngineSettings.json file.

{
  "APIKey": "<ensure your key meets UUID format (https://
www.uuidgenerator.net)>”,
  "RestEndpointURL": "<your Tegaki Server URL here>”,
  "RestEndpointPort": <80>,
  "EngineType": 3,
  "EnableFieldMerging": false,
  "EnableFieldRegions": false,
  "DebuggingFolder": "C:\\Users\\Public\\Documents\\Automation
 Anywhere IQBot Platform\\Logs\\Engine\\Tegaki"
}

См. раздел How to change OCR Settings in IQ Bot (A-People login required).

4. Перейдите к ..\Automation 360 IQ Bot\Configurations\Settings.txt и измените
следующее значение: OCREngine=TegakiAPI.
Файл TegakiOCREngineSettings.json становится доступным после установки IQ Bot.

1. Создайте новый обучаемый экземпляр с использованием документа на одном из азиатских
языков, который вы хотите обучить.

2. Обучите документ и переведите обучаемый экземпляр в рабочий режим.
3. Отправьте файлы на азиатском языке и запустите бот.
4. Выполните загрузку и просмотрите точность результатов извлечения.

Понятия, связанные с данным
Install and update Automation 360 IQ Bot
This collection of topics guide you through the process of installing or setting up Automation 360 IQ Bot
On-Premises and Cloud.
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Resolving IQ Bot registration failure
Use the instructions in this topic if IQ Bot registration fails due to HTTPs URL issues.
1. Use Windows Services to restart the Control Room service.
2. Update the Control Room HTTPs URL by logging in to Control Room > Administration > Settings

> General.
3. Use Windows Services to restart the following services:

• Automation Anywhere Control Room Cognitive Console
• Automation Anywhere Control Room Reverse Proxy

4. Re-register IQ Bot with the HTTPs URL in the Control Room.
IQ Bot is registered successfully.

Unregistering IQ Bot from the Control Room
You have to unregister IQ Bot from the Control Room if the IQ Bot URL changes because of installation or
uninstallation of IQ Bot, or when a load balancer is added.
After unregistering IQ Bot from the Automation Anywhere Control Room, restart the Automation Anywhere
Cognitive Console service.
1. Using the sysadmin role, run two separate SQL queries in different databases.
2. Run the first set of SQL statements in the Control Room database to delete the following data:

Run the following SQL statements for versions A2019.10 to A2019.13:

DELETE FROM [AAE-Database].[dbo].[ACTIVEMQ_ACKS]

DELETE FROM [AAE-Database].[dbo].[ACTIVEMQ_MSGS]

DELETE FROM [AAE-Database].[dbo].[SERVICE_USER]

DELETE FROM [AAE-Database].[dbo].[USERS] where user_type='APP'

Run the following SQL statements for version A2019.14 and later:
a. Run the following query:

USE [AAE-Database]
SELECT T.uuid As TenantID,T.name AS
 TenantName,T.created_by,T.enabled,U.id AS
 IQBotAppUserId,U.user_type,S.url AS 
IQBotURL FROM [dbo].[TENANTS] T 
LEFT JOIN [dbo].[USERS] U ON T.uuid = U.tenant_uuid 
LEFT JOIN [dbo].[SERVICE_USER] S ON U.id = S.id
WHERE (U.user_type='APP' AND S.type='IQBOT')

b. The above query will provide you an 'IQBotAppUserId' number. Replace id = 'IQBotAppUserId'.
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c. Execute the following delete queries:

DELETE FROM [AAE-Database].[dbo].[SERVICE_USER] WHERE [type]='IQBOT'

d. DELETE FROM [AAE-Database].[dbo].[USERS] WHERE id = 'IQBotAppUserId'

3. Run the second set of SQL statements in the IQ Bot configuration database to delete the following
data:
• DELETE FROM [IQBot].[dbo].[Configurations] where

 [key]='controlRoomVersion'

• DELETE FROM [IQBot].[dbo].[Configurations] where [key]='appRegistered'

• DELETE FROM [IQBot].[dbo].[Configurations] where [key]='controlRoomUrl'

• DELETE FROM [IQBot].[dbo].[Configurations] where [key]='appId'

You have unregistered successfully.

Set up log file automatic rollover
This topic addresses setting up automatic rollover of log files based on the file size.
After the log files are created, the system continues logging messages, which increases the log file size to
a point where they are too large to open. This prevents the user from opening the log files for reviewing
the information and error messages.

Прим.:
• This happens sooner if the logging level is increased to DEBUG or TRACE modes.
• To ensure smooth operation of the system, manual clear the logs periodically.

For all Java services, user can identify the log files under <IQ Bot installation directory>/
Services . Open any logging configuration file, and add the following change under
<SizeBasedTriggeringPolicy size="100MB" /> in the first occurrence of Policies:

<Policies>
<TimeBasedTriggeringPolicy interval="720" />
<SizeBasedTriggeringPolicy size="50MB" />
</Policies>

In the following example setting, after the log file reaches 50 MB, the system creates a new file
automatically and starts logging in it. Though the user ends up with more files, but each file would be 50
MB only. This is standard practice to manage log files.

This example shows entries a user can add to the setting for Automation 360 IQ Bot On-Premises to
automatically roll over the logs after the files reach a certain size.

<RollingFile name="Alias" fileName="${env:PUBLIC}/Documents/Automation
 Anywhere IQBot Platform/Logs/Alias.log"
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                     filePattern="${env:PUBLIC}/Documents/Automation
 Anywhere IQBot Platform/Logs/Archive/$${date:yyyy-MMM}/Alias-%d{yyyy-MMM-
dd}-%i.log.zip"
                     immediateFlush="true"
                     append="true">
            <PatternLayout pattern="CPL1 Alias %X{cid} %d{ISO8601}{UTC}Z
 %-5level %C %M %msg %n"/>
            <Policies>
                <TimeBasedTriggeringPolicy />
                <SizeBasedTriggeringPolicy size="50MB" />
            </Policies>
            <DefaultRolloverStrategy max="10"/>
        </RollingFile>

Health Check API response if RabbitMQ v3.8.18 fails to start
Check the status of each IQ Bot service using the Health Check API if RabbitMQ v3.8.18 fails to start.
The Health Check response for RabbitMQ startup failure is different in case of FileManager, Project,
Validator, VisionBot as described in the following table.

Service name Health Check response Reason for failure

FileManager

http://
<hostname>:<9996>/
healthcheck

Failure 1:
localhost refused to
 connect

Failure 2:
localhost refused to
 connect

Reason for failure 1:
The RabbitMQ v3.8.18 node/
service went down when
the Filemanager service was
running.
Reason for failure 2:
The RabbitMQ node/service
was already down when the
Filemanager service started.

Project

http://
<hostname>:<9999>/
healthcheck

Failure:
localhost refused to
 connect

Reason for failure:
The RabbitMQ v3.8.18 node/
service is down.

Validator

http://
<hostname>:<9995>/
healthcheck

Failure:
localhost refused to
 connect

Reason for failure:
The RabbitMQ v3.8.18 node/
service is down.

VisionBotManager

http://
<hostname>:<9998>/
healthcheck

Failure:
localhost refused to
 connect

Reason for failure:
The RabbitMQ v3.8.18 node/
service is down.
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Service name Health Check response Reason for failure

Gateway-2 service

http://<hostname>:8100/
healthcheck

Application: gateway-2
Failure 1:
localhost refused to
 connect

Failure 2:
localhost refused to
 connect

Reason for failure 1:
Port is blocked and the
Gateway-2 service is running.
Reason for failure 2:
The Gateway-2 service is not
running.

Reinstalling HTTPS SSL certificate for secure communication when it expires
Reinstall HTTPs SSL certificate in Automation 360 IQ Bot when your HTTPS SSL certificate expires.
The HTTPS SSL certificate is required for secure and encrypted communication between your browser
and IQ Bot, to protect highly confidential online transactions, for example, online financial and shopping
transactions. The padlock icon on your browser indicates that you have an active secure connection.
To enable a secure connection, get the HTTPS SSL certificate as follows:
1. Go to %installation_dir%\Configurations and as an administrator, run

stopanduninstallallservices.bat.

Прим.:  In a cluster installation, stop the services on each of the nodes for IQ Bot and Control Room
cluster.

2. Go to %installation_dir%\Portal\keys and make a backup of the cert.crt, key.key, and
ca.crt files.

3. Convert the .pfx file of the IQ Bot certificate to .crt and .key formats by running the following
commands:
• Extract an encrypted key from .pfx file.

openssl.exe pkcs12 -in "path_to_cert\example.pfx" -nocerts -out
"path_to_cert\example encp.key" 

Прим.:  If the .pfx file is password protected, you need to enter the pass phrase when prompted.

• Convert an encrypted key to a readable format.

openssl.exe rsa -in "path_to_cert\example encp.key" -out "path_to_cert
\key.key"
This command converts encrypted key to a readable format.

• Convert the .pfx file to .crt format.

openssl.exe pkcs12 -in "path_to_cert\example.pfx" -clcerts -nokeys -out
"path_to_cert\cert.crt"

• Fetch the ca.crt file from the Control Room certifcate (.pfx) file only if the Control Room
certificate also expires.

openssl pkcs12 -in <filename.pfx> -cacerts -nokeys -chain -out <ca.crt>
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4. Copy or replace the cert.crt, and key.key (generated in the previous step), and the ca.cert
(generated using the Control Room certificate .pfx file ) to the %installation_dir%\Portal
\keys folder.

5. Import the IQ Bot public certificate into the Java Key store for IQ Bot by running this command as a
system administrator:

 
"JRE Location\bin\keytool.exe" -import -alias iqbot-keystore "cacerts
 location of iq bot" -file " iq bot public certificate file"

Пример. C:\Program Files (x86)\Automation Anywhere IQ Bot <version number>
\JRE\1.8.0_161\bin\keytool.exe" -import -alias cr -keystore "C:\Program
 Files (x86)\Automation Anywhere IQ Bot <version number>\JRE\1.8.0_161\lib
\security\cacerts" -file "C:\Certificate\cert.crt

6. To import the IQ Bot public certificate into Control Room, go to the Control Room installation
path, such as: C:\Program Files\Automation Anywhere\Enterprise, and run the
following command as a system administrator: jrk\bin\java -jar certmgr.jar -appDir
 "C:\Program Files\Automation Anywhere\Enterprise" -importTrustCert "C:
\Certificate\cert.crt".

7. After importing the certificates, restart the Control Room and IQ Bot servers.
This refreshes the system caches.

8. On IQ Bot Server, go to %installation_dir%\Configurations and as an administrator, run
installandstartallservices.bat.

If the Control Room certificate expires
1. Follow the steps: Import HTTPS and CA certificates

2. Convert .pfx to .crt format.openssl.exe pkcs12 -in "path_to_cert\example.pfx" -
clcerts -nokeys -out "path_to_cert\cert.crt".

3. Fetch the ca.crt file from the Control Room certificate (.pfx) file.openssl pkcs12 -in
 <filename.pfx> -cacerts -nokeys -chain -out <ca.crt>

4. Copy or replace the ca.cert to the keys folder in IQ Bot.
5. Import the Control Room public certificate into Java Key store for IQ Bot by running this command

as a system administrator: "JRE Location\bin\keytool.exe" -import -alias cr
 -keystore "cacerts location of iq bot" -file "control room public
 certificate file".
Пример. C:\Program Files (x86)\Automation Anywhere IQ Bot <version number>
\JRE\1.8.0_161\bin\keytool.exe" -import -alias cr -keystore "C:\Program
 Files (x86)\Automation Anywhere IQ Bot <version number>\JRE\1.8.0_161\lib
\security\cacerts" -file "C:\Certificate\cert.crt

Прим.:  To change the Control Room certificate, follow steps here: Import HTTPS and CA certificates

Updating Automation 360 IQ Bot
Update Automation 360 IQ Bot On-Premises to the most recent version for all the latest features and
enhancements.
Ensure you back up your existing IQ Bot learning instances. Depending on the Automation 360 IQ Bot
version you are currently using, the following update options are available:
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• Update from earlier Automation 360 IQ Bot builds (1089, 1598, and 2079) to the latest
Automation 360 IQ Bot On-Prem version
The earlier versions of Automation 360 IQ Bot had five databases. A single unified database is available
starting with Automation 360 IQ Bot On-Premises Сборка 2545. Use the migration script to migrate
these five databases to a unified database.
Run IQ Bot On-Premises database migration script

• Update to the latest version of Automation 360 IQ Bot On-Prem.
Ensure you update your existing Automation 360 IQ Bot On-Premises to the latest version which
provides the product improvements and bug fixes.
Update Automation 360 IQ Bot On-Premises to the latest version

• Troubleshoot CyberArk vault integration for upgrade
If you encounter a vault key validation error while upgrading Automation 360 IQ Bot to Сборка 15112,
troubleshoot the issue by ensuring the JDBC Driver is in the C:\Windows\System32 folder.
Troubleshoot CyberArk vault integration for upgrade (A-People login required)

Run IQ Bot On-Premises database migration script
IQ Bot On-Premises Builds 1089, 1598, and 2079 included five databases. Starting with IQ Bot On-
Premises Сборка 2545, one unified database is supported. You have to run a migration script to migrate
the databases of Builds 1089, 1598, 2079 to the latest build.
Before you run the migration script, you must be on the latest IQ Bot On-Premises build, and verify that
the SQL command utility SQLCMD.exe is installed on your system.
Also, verify and ensure Microsoft ODBC Driver 17 for SQL Server is installed on the IQ Bot server. This can
be obtained from: https://www.microsoft.com/en-us/download/details.aspx?id=56567

1. Uninstall the current build of IQ Bot On-Premises.
2. Install the latest IQ Bot On-Premises build.

During installation, a new IQ Bot database is created.

Прим.:  Remember your database username and password in order to the update migration script
value.

3. Navigate to your Binn folder.
This might be located in C:\Program Files\Microsoft SQL Server\Client SDK\ODBC
\170\Tools\Binn.

4. Verify that SQLCMD.exe is installed.
If SQLCMD.exe is not installed, follow these steps:
a. Download and extract the Data Migration.zip from the Installation Setup folder onto the IQ

Bot server.
b. Navigate to DataMigration > UTILITY-MsSqlCmdLnUtils.
c. Run MsSqlCmdLnUtils.msi to install SQLCMD.exe.

After SQLCMD.exe is installed, run the migration script.
1. Access the AA.IQBot_Database_Migration.bat file within the DataMigration folder.
2. Edit the AA.IQBot_Database_Migration.bat file.
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3. Update the values as follows:
a) Set the SQLCMD value to the path of your Binn.

SQLCMD="C:\Program Files\Microsoft SQL Server\Client SDK\ODBC\170\Tools
\Binn\SQLCMD.exe"

b) Set LOGIN value to your database username.
LOGIN="database username"

Прим.:  The bulkadmin, dbcreator, and public roles are required to run the migration script.

c) Set the PASSWORD value to your database password.
PASSWORD="database password"

d) Set the SERVER value to the path of your database server hostname.
SERVER="path of database server hostname"

4. Run the migration script AA_IQBot_Database_Migration.bat file with administrator privilege.
After the migration is complete, an output is created. Verify C:\Datamigrationlog.txt for log
history and errors.

Прим.:  If an output is not displayed, contact support.

Update Automation 360 IQ Bot On-Premises to the latest version
If you are using any of the earlier versions of Automation 360 IQ Bot On-Premises, you can update to the
latest version, which offers enhancements and bug fixes.
It is recommended that you review your existing Automation 360 IQ Bot On-Premises version and back up
your database, output path, and installation configuration files.

Прим.:  Uninstall the existing version of Automation 360 IQ Bot On-Premises from your device before
updating to the latest version.

1. Go to Automation Anywhere support site to download the latest version of the Automation 360 IQ Bot
setup file.
A-People Downloads page (Login required)

2. Click the link to the latest Automation 360 IQ Bot setup file.
3. Click Installation Setup.
4. Download the Automation_Anywhere_IQ_Bot_A2019_Build_<build number>.exe file and

install it.
Install and update Automation 360 IQ Bot

The latest version of Automation 360 IQ Bot On-Premises is installed on your device.

Upgrading and downgrading IQ Bot
Uninstall and install a later version to upgrade IQ Bot. Uninstall and install an earlier version of IQ Bot to
downgrade.
To upgrade or downgrade IQ Bot, perform the following procedure.
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• Upgrading IQ Bot
a) Create a new folder in any location and take a backup of the Settings.txt

and both or either of the .json files ImageProcessingConfig.json or
AbbyyImagePreProcessingSettings.json for your reference from the <Installation Path/
Configuration> folder to this new folder.

b) Take a backup of the existing IQ Bot databases before starting the upgrade.
c) Follow the uninstall process:

Uninstalling IQ Bot

d) Copy a later version of IQ Bot installable file from <path of the installable file> to your local system.
e) Follow the installation process.

Прим.:
• Refer to the settings from the Settings.txt and both or either of the .json files

ImageProcessingConfig.json or AbbyyImagePreProcessingSettings.jsonto enter
the configuration values when you are installing an earlier version of the product.

• Back up your database to restore it in case any issue occurs in future or in case you downgrade
to an earlier version of IQ Bot.

• If you are using the ABBYY FineReader Engine OCR, you must update the folder path to the
AbbyyOCREngineSettings.json configuration file after completing the upgrade installation
steps.

Migrate learning instances

• Downgrading IQ Bot
a) Create a new folder in any location and take a backup of the Settings.txt

and both or either of the .json files ImageProcessingConfig.json or
AbbyyImagePreProcessingSettings.json for your reference from the <Installation Path/
Configuration> folder to this new folder.

b) Uninstall the later version of IQ Bot.
c) Take a backup of the current databases.
d) Remove the backup of the current databases.
e) Restore the database backup of the earlier IQ Bot version.
f) Install the earlier version of IQ Bot.

Прим.:
• Refer to the settings from the Settings.txt and both or either of the .json files

ImageProcessingConfig.json or AbbyyImagePreProcessingSettings.jsonto enter
the configuration values when you are installing an earlier version of the product.

• Back up your database to restore it in case any issue occurs in future or in case you upgrade to
a different version of IQ Bot.
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Uninstalling IQ Bot
If you have installed Automation 360 IQ Bot On-Premises, use these steps to uninstall IQ Bot and its
dependencies.
To manually uninstall, go to Windows > Control Panel > Programs > Uninstall a program, and
choose IQ Bot.
For all other versions, use the following steps.
1. Double-click the Automation_360_IQ_BOT_<version-number>.exe installer file. The

Automation Anywhere IQ Bot - Wizard appears.
2. Enter the administrative permissions in the User Access Control dialog box if a dialog box appears.

Прим.:  Ensure you close all the existing browser instances running IQ Bot before you begin
uninstallation.

3. Щелкните Вперед. The Ready to Remove page appears.
4. Click Remove.

The uninstallation process begins.

Прим.:  During the uninstallation process, if setup information appears, click OK to continue. Clicking
Cancel to close the process.

5. When complete, the Finished page appears. Click Finish to complete the process.

Прим.:  Uninstalling IQ Bot does not delete the IQ Bot database or any of the following dependencies.
Manually remove them using recommended third party procedures.
• Erlang/OTP
• RabbitMQ v3.8.18
• NodeJS
• Сервер SQL Native Client
• Python

High Availability and Disaster Recovery overview
High availability (HA) provides a failover mechanism if an IQ Bot service or server fails. Disaster recovery
(DR) enables recovery across a geographically separated distance if a disaster causes an entire data center
to fail.
IQ Bot uses a minimum of 3 nodes and a maximum of 5 nodes in a cluster for high availability (HA).

IQ Bot HA and DR solution

In the context of IQ Bot, implementation of High Availability (HA) and Disaster Recovery (DR) reduces
downtime and maintains continuity of business (CoB) for your бот activities.
• High Availability (HA)—High availability is an architectural system design that attempts to safeguard

a system against certain failure scenarios. This means that even if parts of a system is failing, as a
whole it is still available and usable. High availability solutions typically protect against specific scenarios
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such as: server failures, single component failures, dependency failures, variable load increases, and
networks splits where dependent on system components that become unreachable on a network.

• Disaster Recovery (DR)—Disaster recovery involves a set of policies and procedures to enable the
recovery or continuation of vital infrastructure and systems following a natural or human-induced
disaster. Disaster recovery addresses many different causes of failures in a system where high
availability typically accounts for a predictable few. Disaster recovery has a focus on re-establishing
services after an incident not just failover. Recovery of a system includes scenarios such as: restarting a
service or system, restoring configuration files or a database from backups.

To ensure HA and DR protection of your IQ Bot components, configure your existing HA and DR
infrastructure, load balancing, and failover systems to include IQ Bot servers and services. See your data
center administrator for your approved local HA and DR procedures.

Required HA and DR infrastructure elements

• Distributed Approach—In addition to clustering IQ Bot related data center components, we also
recommend that you deploy IQ Bot on multiple physical and, or virtual servers.

• Load balancing—Performed by a load balancer, this is the process of distributing application
or network traffic across multiple servers to protect service activities and allows workloads to be
distributed among multiple servers. This ensures бот activity continues on clustered servers.

• Databases—Databases use their own built-in failover to protect the data. This ensures database data
recovery.
• Between the HA clusters, configure synchronous replication between the primary (active) and

secondary (passive) clustered MS SQL servers in the data center. This ensures consistency in the
event of a database node failure.
For the required HA synchronous replication, configure one of the following:
• Backup replica to Synchronous-Commit mode of SQL Server Always On availability groups
• SQL to Server Database Mirroring

• Between the DR sites, configure your database to provide asynchronous replication from the
primary (production) DR site to the secondary (recovery) DR site that is at a geographically
separated location from the primary DR site.

Sample scenario

Point all IQ Bot instances within the same cluster to the same database and repository files. This is
required to enable sharing data across multiple servers and ensuring data integrity is maintained across IQ
Bots servers within a cluster.

HA and DR deployment models

To ensure your IQ Bot is protected by HA and, or DR, configure your data centers according to the
deployment models described in:
• High Availability deployment model
• Disaster Recovery deployment model
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HA implementation requirements

• Install IQ Bot on multiple servers.
• Access to IQ Bot is through a load balancer.
• Open a RabbitMQ v3.8.18 synchronization port between IQ Bot servers.
• Configure the Microsoft SQL Server in high availability mode.

Installation HA and DR configuration requirements

• The IQ Bot installer does not directly support cluster installation. To set up a cluster do the following:
• Run the installer on each application server node.
• Share the output folder using the access role Everyone.
• Post installation, execute the messagequeue_cluster_configuration.bat with appropriate

command line arguments.

• Configure IQ Bot in a high availability configuration.
• Open firewall ports: 4369 and 25672.
• Install RabbitMQ v3.8.18 on every IQ Bot node in the cluster.

The first node where IQ Bot is installed becomes the primary RabbitMQ v3.8.18 node. The host name
of the primary node is used to configure the RabbitMQ v3.8.18 cluster.

• The load balancer is required to distribute a traffic to all IQ Bot server nodes.
• Configure Microsoft SQL Server for high availability. Use the Microsoft SQL Server Always On option.
• For RabbitMQ v3.8.18 specific installation, see your RabbitMQ v3.8.18 documentation.

HA and DR known limitations

• To discover the availability of IQ Bot instances, a load balancer periodically sends pings, attempts
connections, or sends requests to test the IQ Bot instances. These tests are called health checks.

• Health checks do not verify the availability of RabbitMQ v3.8.18 instances.

HA cluster configuration overview
To support Automation Anywhere your data center, configure an HA cluster. Follow your company methods
and procedures for implementing your data center cluster.
HA clusters protect services and data in the event of a server or service failure. The following is a list of
processes associated with clusters.

Database replication Configure synchronous replication between the
primary site (active) and secondary site (passive)
MS SQL servers to ensure consistency in the event
of a database node failure.

Downtime The amount of downtime depends on the number
of restart attempts the administrator configures for
the primary server services, the number of failovers
allowed per number of hours, and the failback
configuration.
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Failback After the primary server is returned to normal, fail
back the workload from the secondary servers to
the primary servers. The primary server becomes
the active server again.
Restoring operations to the primary system or site
after a failover or disaster recovery on a secondary
system or site.

Failover If one of the primary servers fails, the workload
of the failed server automatically shifts to the
secondary server in the cluster. This automatic
process is called failover. Failover ensures
continuous availability of applications and data.
When failover completes, the secondary server
becomes the active server.
When a (primary) system detects a fault or failure,
it automatically transfers control to a (secondary)
duplicate system. This applies to HA clusters, where
failover is from one server to another.

Graceful degradation Process allowing cluster dependencies to operate
gracefully on a degraded primary site.

Redundancy HA clusters use redundancy to prevent single points
of failure (SPOF), such as a failed server or service.
HA clusters include primary (active) servers that
host services or databases and secondary (passive)
servers that host replicated copies of the services
and databases.

Replication The secondary servers have the same configuration
and software as the primary servers, they are a
duplicate (redundant copy) of the primary. Data is
replicated (copied) from the primary servers to the
secondary servers.

To support HA and DR for Automation Anywhere, configure the selected components in your data center
for HA.

Прим.:  In the context of clusters, though the terms server, host, and node each have specific meaning,
they are frequently used interchangeably.

Cluster A cluster is a set servers (nodes) that are connected
by physical cables and software. In an HA
environment, these clusters of servers are allowed
to be in the same physical data center.

Cluster group (role) Group of clustered services that failover together
and are dependent on each other.

Узел The cluster machine that is hosting the services.
Multiple servers The HA technique where operations are available

across multiple servers with workload managed by
a load balancer. This applies to IQ Bot instances.

Узел A generic term for a machine in a cluster.
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Primary node The active node in the cluster. The machine where
the production activities run. This applies to the
database servers.

Secondary node The machine that is designated as the target in the
event of a failover. The secondary node is a passive
duplicate of the primary node. This applies to the
database servers.

Сервер The machine in the cluster installed with the server
operating system.

HA cluster technologies guard against three specific types of failures:

Application and service failures These affect application software and essential
services.

Site failures in multisite organizations This is caused by natural disasters, power outages,
or connectivity outages.

System and hardware failures This affects hardware components such as CPUs,
drives, memory, network adapters, and power
supplies.

This ability to handle failure allows clusters to meet two requirements that are typical in most data center
environments:

Высокая доступность The ability to provide end users with access to a
service for a high percentage of time and reduces
unscheduled outages.

High reliability The ability to reduce the frequency of system
failure.

High Availability deployment model
The High Availability (HA) deployment model provides failure tolerance for the IQ Bot servers, services,
and databases.
The following shows IQ Bot and data center components.

In this example, the IQ Bot servers and Microsoft SQL Servers have HA redundancy.
• Multiple users have access the IQ Bot cluster through their web browsers. The web browsers

communicate to the IQ Bot cluster through the load balancer.
• Multiple Bot Runner communicate to the IQ Bot cluster through the load balancer.
• The server message block (SMB) file share and the Microsoft SQL Server store data from the IQ Bot

cluster.
• Microsoft SQL Server uses redundancy through replication syncing to the clustered Microsoft SQL

Server.

Pros Maintains availability when server failures occur
within a single data center.

Cons Does not provide protection against data center
outage.
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Use Cases Small to medium-size businesses that do not
require multi-site disaster recovery.

Disaster Recovery deployment model
The Disaster Recovery (DR) deployment model uses high availability (HA) clusters distributed over a
geographic area.
Disaster Recovery (DR) is a method where two high availability (HA) data center configurations are
separated geographically. The extra benefit here from a single location HA configuration is that in the event
of a localized disaster, the physically removed data center resumes functions with minimum downtime.
Prerequisites
Before performing the IQ Bot DR, review the following prerequisites:
• Enable the inbound and outbound ports.
• Add all the hostnames in the host file entries for all the nodes.
• Ensure that the primary and secondary databases are in sync.
• Automation Anywhere Control Room and IQ Bot must be installed on both primary (active) and

secondary (passive) DR sites.
• While switching between the primary and secondary servers, ensure the following:

• If the secondary database has read-only permission, the primary database has read/write
permission.

• If the secondary database has read/write permission, the primary database has read-only
permission.

The following diagram shows the IQ Bot DR setup:

In this example, all the servers have redundancy.
• Multiple users have access the IQ Bot cluster through their web browsers. The web browsers

communicate to the IQ Bot clusters through the load balancers.
• Multiple Bot Runner communicate to their IQ Bot cluster through the load balancer.
• The server message block (SMB) file share and the Microsoft SQL Server store data from their IQ Bot

cluster. Both servers are asynchronously replicated to the backup disaster recovery site.
• Microsoft SQL Server uses redundancy through replication syncing to the clustered Microsoft SQL Server

on the primary disaster recovery site.

For disaster recovery in IQ Bot environment.
• Deploy a second IQ Bot HA cluster in an additional data center that is in a separate geographic location.
• In the event of a primary site failure, do the disaster recovery manually. См. раздел Disaster recovery

failover steps overview.

Прим.:  When a failover to a backup site occurs, it is possible that very recent changes made on the
primary site are lost.

Pros Provides business continuity when faced with data
center outage or loss.

Cons Increased operational burden.
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Contact your Customer Success Manager (CSM) or Partner Enablement Manager (PEM) for more
information on benchmarking IQ Bot On-Premises.Disaster Recovery.
IQ Bot On-Premises Disaster Recovery benchmarking (A-People login required)

DR configuration requirements
When you configure your Disaster Recovery enabled data centers for IQ Bot, ensure the listed conditions
are met.

Disaster Recovery configuration requirements

• Asynchronous replication—Configure asynchronous, rather than synchronous replication, between
DR sites for all supporting services. This ensures off-site replication does not impact performance of the
primary site.

• AD domain—Ensure the same Active Directory domain is available to both the primary and backup
sites.

• Site domains—Ensure the backup site Control Room and device machines are members of the same
domain as the primary site Control Room and machines.

• Licenses—Assign floating licenses for users, so that they are able to log into devices on the backup
site.

• Backup site services—Shutdown the Control Room services at the backup site until they are needed.
• Site configurations—Ensure the machines at the primary site and backup site have the same

specification and configuration. This includes the Control Room, Bot Runner, associated devices, and
login credentials. This is required to ensure equal level of service during an outage.

Прим.:  Schedules are stored in UTC and therefore run at the same time regardless of the physical
location or time zone settings of the server.

Database Replication Details

The database replication configuration for disaster recovery is an extension of the high availability
configuration. This configuration requires the use of Always On availability groups.
• Configure the primary site replica in Synchronous-Commit mode.
• Configure the recovery site replica in Asynchronous-Commit mode. Asynchronous-Commit mode

ensures that the latency and reliability of the inter-datacenter does not impact the performance and
availability of the primary site.

• Do not configure the recovery site replica to offer any database services until a recovery failover is
triggered.

Failure mode

With asynchronous replication there is the possibility that a transaction that occurs on the primary site
does not reach the recovery site replica before the failure occurs.

Прим.:  This possibility of loosing the most recent transactions applies to all DR automated application
solutions using asynchronous replication, not just Automation Anywhere solution.
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Deployment requires strict consistency between distant geographical locations. Synchronous-Commit
configured between replicas with significant latency has a detrimental effect on all Control Room
operations.
To prevent work items being processed twice when a failure occurs, some work items awaiting delivery to
a device are placed into an error state. This ensures they can be manually reviewed and marked as ready
to be processed or complete as appropriate.

Disaster recovery failover steps overview
Overview of failover steps for IQ Bot recovery after a disaster.
Complete the disaster recovery deployment on two geographically separated sites, where one site is
primary (active) and the other is a backup (passive) site. Disaster recovery is performed on remote backup
site.
The procedure is identical regardless of whether switching over from primary to secondary (recovery), or
secondary to primary.
If the failed IQ Bot nodes are still available:
1. Shut off all IQ Bot services at the primary site.
2. Failover all IQ Bot-related databases using the database tools.
3. Failover your Server Message Block (SMB) share using the appropriate tools to make the recovery site

SMB file share writable.
4. Start IQ Bot services at the recovery site.
5. Wait until the IQ Bot web interface is available.
6. Login to the web interface as an administrator.
7. After the recovery site is operating as the primary site, configure a replacement secondary site. Using

the database tools, set replication from the recovery primary site to the replacement secondary site.

Re-establish a duplicate DR site
After a secondary (backup) site is recovered as the primary (production) site, establish a new secondary
DR site.
The recovery site is up and running as the new production site.
The process of returning activity to a primary (active) production site, plus secondary (backup) site
depends on the state of the original primary site.
• If the old production environment becomes available again, complete the following to switch back to

the original DR primary site.
a) Restore/replicate the DR database and file system to the original production database and file

system respectively.
b) Bring up the new DR primary (production) IQ Bot.
c) Verify new DR primary (production) environment is working, as expected.
d) Stop the DR IQ Bot services on the DR recovery site.
e) Establish the replication between the new DR primary (production) and DR secondary (standby) IQ

Bot (DB and NAS).
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• If the old DR primary production environment is rendered completely unusable due to the disaster, re-
establish a new secondary (standby) DR site. Complete the recovery DR steps to re-establish primary
and secondary DR sites.
a) Restore/replicate the database and file system data from DR environment to the new production

environment.

No additional steps are required. The DR primary and secondary sites are restored.
• The бот Activation utility does not need to be run again. Activation occurs when IQ Bot is first deployed

to the DR cluster sites only.
• For any subsequent disasters, only the database query needs to be run on DR secondary (standby)

IQ Bot database. This is required because the replication between DR primary (production) and DR
secondary (standby) overwrites DR secondary site Bot Runner data in DR secondary site database with
DR primary (production) Bot Runner data.

• Similarly, the mapping between DR primary and DR secondary Bot Runner is established. Use the same
mapping for all subsequent disasters or mock drills.
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Миграция в Automation 360

Important:  See Upgrade launchpad (A-People login required) for a self-guided experience tailored to your
Control Room version, with resources and support to migrate to Automation 360.

Миграция — процесс перемещения данных и боты с Enterprise 11 или Enterprise 10 в Automation
360. Миграция включает (среди прочего) репликацию и обновление существующей базы данных
и репозитория, преобразование боты в формат Automation 360, а также перенос обучаемых
экземпляров для IQ Bot и информационных панелей для Bot Insight.
Automation 360 — единая интегрированная облачная платформа цифровых рабочих ресурсов,
созданная для гибкости и оперативности. Миграция на эту платформу позволяет сократить время
окупаемости, обеспечить гибкость бизнеса и снизить совокупную стоимость владения.
Подробнее см. в разделе Сведения о Automation 360 on page 11.

Что такое миграция

В процессе миграции все ваши объекты Enterprise 11 или Enterprise 10 (пользователи, функции,
ячейки и боты) копируются в Automation 360. Это избавляет от необходимости заново создавать
все эти объекты в Automation 360. При миграции исключается возможность пропуска копирования
объекта, который может потребоваться для запуска бот после миграции. После успешной
миграции все объекты Enterprise 11 или Enterprise 10 готовы к использованию в Automation 360, за
исключением боты и MetaBots.
При миграции данных Enterprise 11 или Enterprise 10 боты копируются как файлы .atmx, а MetaBots
копируются как файлы .mbot. Необходимо преобразовать боты и MetaBots в формат Automation
360, прежде чем использовать их.
Миграция также включает перенос обучаемых экземпляров IQ Bot и информационных панелей Bot
Insight.

Миграция IQ Bot При миграции боты Enterprise 11 или
Enterprise 10 выполните миграцию обучаемых
экземпляров IQ Bot. Перед началом миграции
IQ Bot проверьте, что среда Automation 360
установлена и настроена для использования.
Миграция IQ Bot включает в себя миграцию
боты, созданных для использования IQ Bot, а
также обучаемых экземпляров IQ Bot, которые
подготовлены для извлечения данных.
Используйте процедуры обновления сервера и
обучаемых экземпляров IQ Bot, чтобы перенести
информацию в новую систему. См. раздел
Миграция в Automation 360 IQ Bot on page 1354.

Миграция Bot Insight Данные и информационная панель Bot Insight
переносятся в рамках общего процесса
миграции. Это включает клонирование базы
данных Bot Insight (которая отделена от
базы данных Enterprise 11 Control Room) и
использование утилиты предварительной
миграции для извлечения метаданных
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информационной панели (виджеты, макеты и
т. д.).

Этапы миграции

Миграция включает в себя три основных этапа, как показано на следующем изображении:

1. Проверьте готовность к миграции on page 1142
Проанализируйте боты с помощью Bot Scanner и посмотрите созданный отчет, чтобы проверить
готовность к миграции.

2. Подготовка новой Control Room для миграции on page 1183
Выберите модель развертывания (Cloud, On-Premises или с поддержкой облака) и запросите
лицензии на миграцию. Подготовьте Control Room и среду для миграции.

3. Миграция и проверка боты on page 1222
Преобразуйте боты Enterprise 11 или Enterprise 10 в формат Automation 360. После миграции
проверьте, что преобразование боты выполнено, и обновите боты по мере необходимости на
основании отчетов о миграции или этапа тестирования.

Note:  Если вы столкнулись с какой-либо ошибкой при миграции с Enterprise 11 или Enterprise
10, то вам, возможно, придется проверить перенесенные боты или предпринять какие-то
действия с ними. См. раздел Сообщения при выполнении миграции on page 1318.

Инструменты для миграции

Для миграции доступны следующие инструменты:

Bot Scanner Bot Scanner сканирует имеющиеся боты (TaskBots
и MetaBots) и создает отчеты. В этих отчетах
представлена информация о командах и
переменных, используемых в боты, а также
сведения о том, сколько из этих команд и
переменных поддерживается для миграции
в Automation 360. (Ранее сканер назывался
«утилитой предварительной миграции»).

Обзор Bot Scanner on page 1166

Bot Migration Wizard Этот инструмент интегрирован в Automation 360
Control Room и предоставляет инструкции по
процессу преобразования боты в совместимый
формат Automation 360 после выполнения
всех необходимых предварительных действий.
Мастер позволяет выполнить миграцию
различных боты (TaskBots и MetaBots) и
зависимых боты.
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Мастер миграции выполняет миграцию бот
только в том случае, если все компоненты,
используемые в бот, поддерживаются для
миграции в Automation 360.

Миграция корпоративных боты on page 1227

Утилита миграции Cloud Этот инструмент позволяет загрузить все ваши
данные Enterprise 11 в Automation Anywhere
Cloud. После успешной загрузки данных в Cloud
создается Cloud Control Room, и все загруженные
данные становятся доступны для использования
в Control Room. Утилита переносит данные из
репозитория Control Room (боты, их зависимости
и Credential Vault) и базы данных Control Room
(пользователей, функции, расписания, очереди и
настройки Control Room).

Загрузка данных Enterprise 11 с помощью Утилиты
миграции Cloud on page 1193

Утилита миграции данных журнала аудита Эта утилита позволяет экспортировать данные
журнала аудита из Enterprise 11 Control Room в
файл JSON. Необходимо вставить файл JSON в
репозиторий Automation 360, а затем перенести
данные журнала аудита.

Утилита предварительной миграции Bot
Insight

Эта утилита позволяет экспортировать
метаданные информационной панели Enterprise
11 Bot Insight (виджеты и макеты) и профили
информационной панели как ZIP-файл. Вы
должны вставить ZIP-файл в репозиторий
Automation 360, чтобы выполнить миграцию
информационных панелей Bot Insight.

Экспорт информационных панелей Enterprise 11
Bot Insight для миграции on page 1204

Что переносится и что не переносится

Enterprise 10. Ознакомьтесь с информацией о том, что переносится и что не переносится для
модели развертывания On-Premises.

Enterprise 10 Переносится в On-Premises

Боты и их зависимости Да

Credential Vault Да

Функции Да

Пользователи Да

Расписания (они отключаются после
миграции в Automation 360)

Да

Журналы аудита Нет

История управления версиями Боты Нет
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Enterprise 10 Переносится в On-Premises

Устройства и группы устройств Нет

Журналы файловой системы Нет

IQ Bot (миграция IQ Bot требует отдельного
процесса)

Нет

Enterprise 11. Ознакомьтесь с информацией о том, что переносится и что не переносится для
различных моделей развертывания.

Enterprise 11 Cloud On-Premises

Пользователи, функции,
переменные учетных данных
и ячейки

Да Да

Боты и их зависимости Да Да

Расписания (они отключаются
после миграции в Automation
360)

Да Да

Очереди рабочих нагрузок Да Да

Информационные панели Bot
Insight
• Опубликованная

информационная панель
• Информационная

панель по умолчанию
и настраиваемая
информационная панель

Да Да

Данные транзакций Боты
• Данные транзакций личной

рабочей области (боты,
которые запускаются с
лицензией Bot Creator)

• Данные транзакций общей
рабочей области (боты,
которые запускаются с
лицензией Bot Runner)

Да Да

Операционные данные о
выполнении Бот

Да Да

Лицензии Yes (Requires unique license
GUID)

Да

Обучаемые экземпляры IQ
Bot (миграция IQ Bot требует
отдельного процесса)

Нет Да

Журналы аудита Нет Да

Группы устройств Нет Да
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Enterprise 11 Cloud On-Premises

Данные истории Да Да

Настройки Control Room Нет Да

История управления версиями
Боты

Нет Нет

Устройства Нет Нет

Журналы файловой системы Нет Нет

Потоки операций Нет Нет

Информационные панели Bot
Insight для импортированных
боты

Да Нет

Данные файла
AASettings.xml

Нет Нет

Выбор способа миграции

После проверки готовности к миграции текущей версии выберите способ миграции на основе
модели развертывания Automation 360, который отвечает вашим бизнес-требованиям.
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Если у вас указанная версия Начните миграцию

Enterprise 11 • Enterprise 11 to Automation 360 Cloud (using
the Cloud Migration Utility)
Workflow map: Click the following
schematic image to view this migration
workflow in an interactive visual

format:
1. Migrating from Enterprise 11 to Automation

360 Cloud

• Enterprise 11 to Automation 360 On-Premises

Workflow map: Click the following
schematic image to view this migration
workflow in an interactive visual

format:
1. Migrating from Enterprise 11 to Automation

360 On-Premises

• Миграция вручную в облако Automation 360
• Миграция вручную в локальную версию

Automation 360
• Enterprise 11 в экземпляр с поддержкой

облака
• Enterprise 11 в Automation 360 на Linux CentOS
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Если у вас указанная версия Начните миграцию

Enterprise 10 Enterprise 10 to Automation 360 On-Premises

Workflow map: Click the following
schematic image to view this migration
workflow in an interactive visual

format:
1. Migrating from Enterprise 10 to Automation 360

On-Premises

Если у вас много боты, вы можете запускать Automation 360 и Enterprise 11 или 10 параллельно.
Этот метод двойной среды помогает избежать простоев. Выберите одну из следующих процедур в
зависимости от модели развертывания.

Если вы хотите использовать метод двойной
среды

Используйте эту процедуру

Cloud Enterprise 11 и Automation 360 Enterprise 11 и облако Automation 360
параллельно

On-Premises Enterprise 11 и Automation 360 Enterprise 11 и локальная версия Automation 360
параллельно

On-Premises Enterprise 10 и Automation 360 Enterprise 10 и локальная версия Automation 360
параллельно

Другие ресурсы

Следующие ресурсы помогут при работе с Automation 360:
• Upgrade launchpad (A-People login required): Provides a self-guided experience tailored to your Control

Room version, with resources and support to migrate to Automation 360.
• Migration resource center: Доступ к многочисленным ресурсам по миграции, включая видеоролики,

шаблоны проектов и информацию высокого уровня, в одном централизованном местоположении.
• Automation Anywhere University: RPA Training and Certification (A-People login required): Получите доступ

к учебному курсу Миграция в Automation 360.
Узнайте, как использовать Automation 360 с Automation Anywhere University для практического
обучения, предназначенного как для начинающих, так и для опытных разработчиков. Также
доступны варианты обучения под руководством инструктора.

• Automation 360 Migration FAQ
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• XML path is not working which works fine in Enterprise 11

Related tasks
Обновление до последней версии Automation 360 on page 1070
Если вы уже используете Automation 360 On-Premises, этот продукт можно обновить до последней
версии Automation 360.

Рекомендации по миграции
Ознакомьтесь с рекомендациями и инструкциями по процессу миграции (миграция ваших боты, Bot
Insight и IQ Bot), а также по Bot Scanner, Control Room и Credential Vault для успешного завершения
миграции.

Bot Scanner

При использовании Bot Scanner для проверки готовности к миграции учитывайте следующие
рекомендации.
• Создайте копию репозитория Control Room в Enterprise 11 или Enterprise 10.

Создайте копию репозитория Control Room на устройстве, на котором вы хотите запустить Bot
Scanner.

• Используйте последнюю версию Bot Scanner.
Новые версии Bot Scanner доступны с каждым выпуском Automation 360. Последняя версия
поддерживает больше команд и функций Enterprise 11 или Enterprise 10, что помогает вам
решить, когда выполнить миграцию.

• Всегда запускайте Bot Scanner на копии репозитория Enterprise 11 или Enterprise 10.
• Не смешивайте боты из нескольких экземпляров Control Room. Например, если у вас есть два

экземпляра Control Room, не копируйте боты из обоих экземпляров Control Room в одно и то же
место и не используйте это место в Bot Scanner для сканирования боты.

• Тщательно изучите отчет Bot Scanner.
Отчет поможет вам определить, какие боты готовы к миграции и когда будет доступна
поддержка неподдерживаемых команд и функций. Понимание сроков появления
неподдерживаемых команд и функций поможет вам решить, когда следует выполнять миграцию.

Control Room и Credential Vault

• Создайте и сохраните резервную копию репозитория и базы данных Control Room в Enterprise 11
или Enterprise 10 перед установкой Automation 360.
Используйте эту резервную копию для выполнения миграции, чтобы не прерывать
существующую автоматизацию Enterprise 11 или Enterprise 10.

• Не изменяйте имя базы данных при восстановлении резервной копии базы данных Enterprise 11
или Enterprise 10.

• Для миграции не используйте компьютер, на котором уже установлен Automation 360.
• Настройте Credential Vault в экспресс-режиме.
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Создание Бот

При создании новых боты в Enterprise 11 или Enterprise 10 следует учитывать следующие
соображения, чтобы упростить миграцию в Automation 360.

Note:  Эти соображения прежде всего помогут тем пользователям, у которых двойная среда
(Enterprise 11 или Enterprise 10 и Automation 360 работают параллельно).

• Не используйте Microsoft Internet Explorer для создания автоматизаций, так как Microsoft
планирует с июня 2022 года прекратить поддержку Internet Explorer в некоторых операционных
системах.

• Используйте объектно-ориентированную автоматизацию везде, где это возможно. Например,
используйте команду Object Cloning вместо команды Средство веб-записи.

• Используйте AISense Recorder по минимуму, так как миграция этого средства записи пока не
поддерживается в Automation 360.

• Не используйте команды Citrix Automation, Internet Connection, Apache Flex, Adobe Flash или
браузер Microsoft Edge (устаревший) в Object Cloning, так как они не поддерживаются в
Automation 360.

Миграция Бот

• Присвойте необходимые функции и разрешения для миграции пользователям, которые начнут
процесс миграции, а также Bot Runner, которые будут использоваться для миграции бот.

• Присвойте необходимые разрешения устройствам, которые будут использоваться для миграции
бот.

• Установите Bot Agent на устройства, которые будут использоваться для миграции бот.
• Проверьте настройку Automation 360 перед использованием Bot Migration Wizard для миграции

боты.
Создайте и запустите образец бот перед использованием Bot Migration Wizard. Это помогает
обеспечить выполнение предварительных системных условий Automation 360, таких как
регистрация устройства, обновление учетных данных и Auto Login.

• Начните миграцию с бизнес-процесса, для которого все боты полностью готовы к миграции.
• Проверьте наличие необходимых ручных обновлений для перенесенных .

Просмотрите сообщения для перенесенных боты и проверьте, не требуются ли обновления
для перенесенных боты, чтобы можно было запустить эти боты. Список боты, которые требуют
обновлений после миграции, доступен на вкладке Требуется действие в отчете Bot Scanner.

После миграции

• Проверьте перенесенные боты.
Запланируйте специальное время для проверки и убедитесь, что боты успешно перенесены.
Не удаляйте боты формата Enterprise 11 или Enterprise 10 до завершения проверки. Эти боты
должны запускаться после миграции.

• Создайте новые боты в Automation 360 после завершения миграции.
• Если вы обновили какие-либо боты в Enterprise 11 или Enterprise 10 после миграции, вы должны

повторно выполнить миграцию этих боты.
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Миграция Bot Insight

• Создайте резервную копию и восстановите базу данных Enterprise 11 Bot Insight перед
установкой Automation 360.

• Используйте те же учетные данные, которые вы использовали для базы данных Enterprise 11 при
восстановлении базы данных.

Миграция IQ Bot

• Загрузите Помощника по миграции базы данных, который совместим с вашей версией Automation
360.

• Создайте резервные копии баз данных Enterprise 11.
• Прекратите обработку, подготовку и проверку документов в Enterprise 11.
• Подготовьте новую среду для установки IQ Bot и Помощника по миграции базы данных.
• Восстановите резервные копии баз данных Enterprise 11 в разных расположениях.
• Просмотрите файл журнала Помощника по миграции базы данных.
• Очистите информацию о регистрации приложения в базе данных IQ Bot, если используется

новый адрес Automation 360 Control Room.
• Выполните миграцию обучаемых экземпляров по одному. Не помещайте все обучаемые

экземпляры в один файл iqba.

Инструменты миграции
Информация, которая размещалась на этой странице, была перемещена на другие страницы. Для
получения дополнительной информации см. следующие ссылки.
• Обзор миграции, включая информацию, которая ранее была доступна на этой странице, см.

здесь: Миграция в Automation 360 on page 1133.
• Для получения информации о Bot Scanner см. Обзор Bot Scanner on page 1166.
• Для получения информации о Bot Migration Wizard см. Bot Migration Wizard on page 1223.

Проверьте готовность к миграции
Выполните задачи этого потока операций, чтобы проверить уровень готовности к миграции в
Automation 360 с Enterprise 11 и Enterprise 10.

1. Проверьте текущую версию платформы Enterprise 11 или Enterprise 10.
Проверка версии Enterprise 11 или Enterprise 10 для миграции on page 1148

2. Проверьте, поддерживается ли миграция текущей версии Enterprise 11 или Enterprise 10.
Поддерживаемые для миграции версии Control Room on page 1143

3. Сравните Automation 360 и функции Enterprise 11 или Enterprise 10.
Матрица сравнения функций Automation 360 on page 725
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4. Изучите информацию о сопоставлении пакеты и сопоставлении переменных, чтобы определить,
чем отличаются команды и переменные Enterprise 11 или Enterprise 10 от эквивалентных пакеты
и переменных Automation 360.
Сопоставление пакетов для миграции on page 1258 | Сопоставление переменных для миграции
on page 1293

5. Используйте Bot Scanner для анализа боты и определения команд и переменных, используемых
в боты, которые доступны для миграции в Automation 360.
Scan Enterprise 11 or 10 боты using Bot Scanner on page 1168

6. Проанализируйте отчет, созданный в Bot Scanner.
Анализ отчета Bot Scanner для миграции on page 1171

Подготовка новой Control Room для миграции on page 1183

Поддерживаемые для миграции версии Control Room
Просмотрите версии Enterprise 11 Enterprise 10, которые сертифицированы и поддерживаются
для миграции на Automation 360 On-Premises и в общедоступное или частное Cloud на Microsoft
Windows Server. Определение «сертифицированная» версия Enterprise 11 или Enterprise 10 означает,
что основные функциональные возможности этой версии платформы и боты, разработанные с
использованием этой версии, поддерживаются в Automation 360.
С течением времени будет добавляться поддержка других версий Enterprise 11 и Enterprise 10.

Remember:  Версии Enterprise 11 и Enterprise 10, не указанные в представленных ниже таблицах,
не сертифицированы для миграции. Если вы используете версию, которая не сертифицирована для
миграции, и хотите перейти на версию Automation 360, сначала необходимо выполнить обновление
до сертифицированной версии, и только затем приступить к миграции.

If you are migrating from OEM products such as IBM RPA, contact Automation Anywhere Support: Open a
support case (A-People login required)

Миграция On-Premises. Поддерживаемые версии Enterprise 11 и 10

Если вы используете любую из указанных ниже версий Enterprise 11 и Enterprise 10, можно
выполнить миграцию. В таблице также указана базовая версия Automation 360, в которой
поддерживается конкретная версия Enterprise 11 или Enterprise 10.

Поддерживаемые версии Enterprise 11 | Поддерживаемые версии Enterprise 10

Версии Enterprise 11 для миграции On-Premises

Выпуски Enterprise 11 Поддерживаемая версия Control Room Поддерживаемая базовая версия Automation
360

11.3.5 • 11.3.5.5
• 11.3.5.4
• 11.3.5.3
• 11.3.5.2
• 11.3.5.1
• 11.3.5

• v.23 и более поздние версии
• v.24 и более поздние версии
• v.24 и более поздние версии
• v.23 и более поздние версии
• v.16 и более поздние версии
• v.18 и более поздние версии
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Выпуски Enterprise 11 Поддерживаемая версия Control Room Поддерживаемая базовая версия Automation
360

11.3.4 • 11.3.4.7
• 11.3.4.6
• 11.3.4.5
• 11.3.4.4
• 11.3.4.3
• 11.3.4.2
• 11.3.4.1
• 11.3.4

• v.25 и более поздние версии
• v.23 и более поздние версии
• v.24 и более поздние версии
• v.23 и более поздние версии
• v.16 и более поздние версии
• v.20 и более поздние версии
• v.19 и более поздние версии
• v.17 и более поздние версии

11.3.3 • 11.3.3.5
• 11.3.3.3
• 11.3.3.2
• 11.3.3.1
• 11.3.3

• v.23 и более поздние версии
• v.16 и более поздние версии
• v.22 и более поздние версии
• v.21 и более поздние версии
• v.17 и более поздние версии

11.3.2 • 11.3.2.5
• 11.3.2.4
• 11.3.2.2
• 11.3.2.1
• 11.3.2

• v.23 и более поздние версии
• v.15 и более поздние версии
• v.09 и более поздние версии
• v.09 и более поздние версии
• v.08 и более поздние версии

11.3.1 • 11.3.1.11 (выше 11.3.1)
• 11.3.1.11 (выше 11.3.1.2)
• 11.3.1.10
• 11.3.1.9
• 11.3.1.8
• 11.3.1.7
• 11.3.1.5
• 11.3.1.4
• 11.3.1.2
• 11.3.1.1
• 11.3.1

• v.23 и более поздние версии
• v.23 и более поздние версии
• v.22 и более поздние версии
• v.17 и более поздние версии
• v.19 и более поздние версии
• v.15 и более поздние версии
• v.17 и более поздние версии
• v.20 и более поздние версии
• v.22 и более поздние версии
• v.21 и более поздние версии
• v.09 и более поздние версии

11,3 11,3 v.10 и более поздние версии

11.2.1 • 11.2.1.6
• 11.2.1.5
• 11.2.1.4
• 11.2.1.3
• 11.2.1.2
• 11.2.1.1
• 11.2.1

• v.23 и более поздние версии
• v.20 и более поздние версии
• v.15 и более поздние версии
• v.11 и более поздние версии
• v.11 и более поздние версии
• v.23 и более поздние версии
• v.23 и более поздние версии

11,2 11,2 v.19 и более поздние версии
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Выпуски Enterprise 11 Поддерживаемая версия Control Room Поддерживаемая базовая версия Automation
360

11,1 • 11.1.2
• 11.1.0

• v.22 и более поздние версии
• v.23 и более поздние версии

Версии Enterprise 10 для миграции On-Premises

Поддерживаемая версия Control Room
Enterprise 10

Поддерживаемая базовая версия Automation
360

10.7.5 v.16 и более поздние версии

10.5.141 v.22 и более поздние версии

10.5.113 v.18 и более поздние версии

10.5.112 v.18 и более поздние версии

10.5.17 v.18 и более поздние версии

10.5.16 v.12 и более поздние версии

10.5.15 v.16 и более поздние версии

10.5.14 v.22 и более поздние версии

10.5.13 v.20 и более поздние версии

10.5.12 v.22 и более поздние версии

10.5.11 v.15 и более поздние версии

10.5.9 v.17 и более поздние версии

10.5.0 v.12 и более поздние версии

10.3.11 v.25 and later

10.3.5 v.25 and later

10.3.0 v.22 и более поздние версии

Миграция Cloud. Поддерживаемые версии Enterprise 11

Если вы используете одну из указанных ниже версий Enterprise 11, можно выполнить миграцию
Cloud.
All supported Enterprise 11 Control Room versions listed in this table also support Bot Insight migrations.

Выпуски Enterprise 11 Поддерживаемые версии Control Room

11.3.5 • 11.3.5.5
• 11.3.5.4
• 11.3.5.3
• 11.3.5.2
• 11.3.5.1
• 11.3.5
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Выпуски Enterprise 11 Поддерживаемые версии Control Room

11.3.5 Сертифицировано для версий установщика
IBM:
• 11.0.0.10.iFix004 (начиная с Automation

Anywhere 11.3.5.4)
• 11.0.0.10.iFix003 (начиная с Automation

Anywhere 11.3.5.3)
• 11.0.0.10.iFix002 (начиная с Automation

Anywhere 11.3.5.2)
• 11.0.0.10.iFix001 (начиная с Automation

Anywhere 11.3.5.1)
• 11.0.0.10 (начиная с обновления

Automation Anywhere 11.3.5 JDK)
• 11.0.0.9 (начиная с Automation

Anywhere 11.3.5)

11.3.4 • 11.3.4.6
• 11.3.4.5
• 11.3.4.4
• 11.3.4.3
• 11.3.4.2
• 11.3.4.1
• 11.3.4

11.3.3 • 11.3.3.5
• 11.3.3.3
• 11.3.3.2
• 11.3.3.1
• 11.3.3

11.3.2 • 11.3.2.5
• 11.3.2.4
• 11.3.2.2
• 11.3.2.1
• 11.3.2
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Выпуски Enterprise 11 Поддерживаемые версии Control Room

11.3.1 • 11.3.1.11 (выше 11.3.1.2)
• 11.3.1.11 (выше 11.3.1)
• 11.3.1.10 (выше 11.3.1)
• 11.3.1.9 (выше 11.3.1)
• 11.3.1.7 (выше 11.3.1.2)
• 11.3.1.7 (выше 11.3.1)
• 11.3.1.5 (выше 11.3.1)
• 11.3.1.4 (выше 11.3.1.2)
• 11.3.1.4 (выше 11.3.1)
• 11.3.1.2
• 11.3.1.1
• 11.3.1

11,3 11,3

11,2 • 11.2.1.6
• 11.2.1.5
• 11.2.1.4
• 11.2.1.3
• 11.2.1.2
• 11.2.1.1
• 11.2.1
• 11,2

11,1 • 11.1.2
• 11.1.0

Миграция Cloud. Поддерживаемые типы развертывания баз данных

Миграция Cloud поддерживается для указанных ниже типов развертывания баз данных.

Тип развертывания базы
данных

Входящая в состав база
данных

Не входящая в состав база
данных

Microsoft SQL Server на AWS
RDS

Да Да

Microsoft SQL Server на Azure
PaaS

Да Да

Microsoft SQL Server на Google
Cloud

Да Да

Поддерживаемые версии баз данных Microsoft SQL Server
Для типов развертывания баз данных, перечисленных в предыдущей таблице, можно разместить
любую из указанных ниже версий баз данных Microsoft SQL Server. Обратите внимание, что для
миграции поддерживаются все выпуски базы данных (Enterprise, Express, Standard, Developer (для
2019) и GCP Cloud SQL).
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База данных Сборка Версия файла Поддерживаемая
операционная
система

12.0.2000.8 2014.120.2000.8Microsoft SQL
Server 2014 12.0.6024.0 2014.120.6024.0

Windows
Server 2012 R2
Standard и более
поздние версии

Microsoft SQL
Server 2016

13.0.5026.0 2015.131.5026.0 Windows
Server 2012 R2
Standard и более
поздние версии

Microsoft SQL
Server 2017

14.0.1000.169 2017.140.1000.169 Windows
Server 2012 R2
Standard и более
поздние версии

Microsoft SQL
Server 2019

15.0.2000.5 2019.150.2000.5 Windows Server 2016 и
более поздние версии

Проверка версии Enterprise 11 или Enterprise 10 для миграции
Миграция в Automation 360 поддерживается для многих сертифицированных версий Enterprise 10 и
Enterprise 11. Перед началом миграции проверьте текущую версию платформы, а затем проверьте,
поддерживается ли эта версия в настоящее время для миграции.

Проверка текущей версии платформы

Вы можете просмотреть текущую версию платформы в Control Room и в Enterprise Client. Проверка
версии платформы в Control Room:
1. Выполните вход в Enterprise 11 Control Room.
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2. Щелкните значок справки в правом верхнем углу Control Room, чтобы проверить номер версии,
который указан в нижней части меню.

Проверка версий, поддерживаемых для миграции

После проверки версии Enterprise 11 или Enterprise 10, развернутой вашей организацией,
посмотрите, какие версии поддерживаются для миграции.
1. Перейдите на следующую страницу: Поддерживаемые для миграции версии Control Room on page

1143.
2. Проверьте, поддерживается ли миграция вашей версии.

На этой странице указаны поддерживаемые версии для миграции в Cloud и On-Premises.

Версия платформы не входит в список поддерживаемых

Хотя мы рекомендуем начинать миграцию после подтверждения того, что ваша версия
поддерживается для миграции, вы все равно можете запустить Bot Scanner, чтобы определить,
какие боты и соответствующие им команды готовы к миграции. Это поможет вам спланировать
миграцию. Вы узнаете, когда неподдерживаемые в настоящее время боты и команды начнут
поддерживаться.

Неподдерживаемые функции для миграции
Ознакомьтесь со списком функций, которые не поддерживаются для миграции с Enterprise 11 или
Enterprise 10 в Automation 360.
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Features not yet supported

Следующие функции пока не поддерживаются для миграции:
• Migration of audit logs from Enterprise 11 is not supported on Cloud deployments.
• In Enterprise 11, if боты were using the Before-After string operation with the OR logical operator

and operation output resulted in an empty string, then the output displayed as an empty string.
However in Automation 360, if the output of such an operation results in an empty string, the value
used in the End before text string operation is ignored and the result displays in the output.
For example, in the text email:user@outlook.com, if the value in the Before operation is email:
and the value in After operation is user, the results differ based on product version:
• Enterprise 11 displays an empty string as the output.
• Automation 360 displays user@outlook.com as the output.

• In Enterprise 11, if users select internal variables for the window titles; but not used in the бот, after
migration, these internal variables are also migrated to Automation 360.

• In migrated боты, if you are using OLE DB Driver version 18 or later and when you export Сервер SQL
Database with bit columns to a CSV file, the bit value of -1 is returned instead of 1 for string value
TRUE.
Fixed in: v.27

• When you migrate боты using SAP > Select item by index command, incorrect index is displayed in
the migrated бот.
Fixed in: v.26

• Боты that include the Эмулятор терминала пакет are migrated only to Advanced Technology and
not to Legacy Technology.

• Когда вы выполняете миграцию бот, который использовал action Manage Window Controls,
последняя цифра значения высоты недоступна после миграции. Тем не менее, бот будет
выполнен успешно.
Fixed in: v.26

• Когда сеанс Excel активен в SAP, соответствующий процесс Excel запускается в фоновом
режиме. В таком сценарии Automation 360 использует тот же процесс Excel, который запущен
в SAP. Когда вы запускаете бот для автоматизации данных электронной таблицы, Automation
360 успешно обрабатывает первый запрос. Но если Excel закрыт во время выполнения и
отправляется следующий запрос на автоматизацию данных электронной таблицы, Automation
360 не обрабатывает запрос, поскольку к процессу Excel все еще обращается SAP. Поэтому для
автоматизации данных электронной таблицы не активируется нужное окно.
Fixed in: v.26

• If a бот is using the Structured text type field in the PDF > Extract text action, some of the
characters might not be extracted correctly.
Fixed in: v.25

• After migration, the Before, Before and/or after, and After options in the String > Extract text
action does not match the case in a string.
Fixed in: v.25

• After migration, боты that were using the Get text > All lines action in Enterprise 11 will display only
24 rows of lines in the Эмулятор терминала.
Fixed in: v.26

• Migrating боты with Get Total Rows command in SAP GUI returns values as Float string type instead
of an Integer type after migration.
Fixed in: v.26
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• If you are a Bot Creator or a Bot Runner user, you might not be able to view the Review messages
displayed in the Bot Assistant without having the View migration permission.
Fixed in: v.26

• When you use counter as a variable in a nested loop, the parent loop functions properly but the child
loop does not run as expected.
Fixed in: v.27

• Боты with SAP packages cannot pick and convert window titles that include "*" (asterisk) character.
These window titles are not converted to currently active window names after migration.
Fixed in: v.26

• Бот deployment might fail when you run migrated боты with the SAP > Get Property command.
This issue occurs because of the following reason: In Enterprise 11, property name is case in-sensitive.
During migration, property name is changed to being case sensitive, so бот deployment fails when the
case of property name does not match.
Fixed in: v.26

• When you send an email through Exchange Web Services (EWS), the format of the email output do
not have line breaks , the content appears tampered, and the entire content of the email appears in a
single line.
Fixed in: v.26

• Bot Runner в Enterprise 11 или Enterprise 10 и устройства Bot Creator не включены в процесс
миграции и поэтому не переносятся в Automation 360.
Automation 360 Bot Agent заменяет Enterprise Client в Enterprise 11 и Enterprise 10. Используйте
Bot Agent для подключения устройства к Automation 360 Control Room и запуска боты на
подключенных устройствах.

• When you run a migrated бот with the option Validate if attachment is missing option checked,
and if the attachment is missing when you send the email, the бот might not run successfully.

• Потоки операций, триггеры, история управления версиями боты и журналы файловой системы.
• Миграция боты Enterprise 11, при которой используется Subversion Version Control для управления

версиями.
• Migration of Enterprise 11 On-Premises Control Room to Automation 360 Cloud service on GCP using

the Cloud Migration Utility is not supported.
• Control Room, которая использует Oracle Database.

Fixed in: v.26
• Миграция данных Bot Insight и других объектов, таких как пользователи, функции, расписания

и переменные учетных данных, когда решение Automation 360 установлено с использованием
свежей базы данных.

• Функции вырезания, копирования, вставки и Ctrl+A на экране терминала при использовании
Эмулятор терминала.
Fixed in: v.27

• Использование переменной внутри переменной (кроме переменных типа значения) в бот.
Например, если бот содержит переменную $variable1$, где $variable1$ содержит $variable2$, а
$variable2$ содержит фактическое значение, этот бот нельзя перенести.

• Использование фиксированного значения и переменной для указания позиции индекса, например
$v_ArrVar(1$RowIndex$,1)$.

• Возможность создания снимков из окна среды выполнения во время выполнения бот.
• боты Enterprise 11 или Enterprise 10, которые используют значение строки в переменной,

используемой в команде Если вместе с оператором «<» или «=», переносятся в Automation 360.
Однако для этих боты возникает ошибка, когда они выполняются в Automation 360.
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• Для команды Если или Цикл, в которых используется оператор «<», «>», «<=» или «>=» с
переменными, содержащими значение строки, после миграции возникает ошибка.
Например, если у вас есть бот, который содержит переменную со значением abcd, и в нем
используется оператор «>», то после миграции при запуске бот возникнет ошибка, так как в
переменных строкового типа не должны использоваться операторы «<», «>», «<=» и «>=».

• Команда Object Cloning, которая автоматизирует следующие приложения:
• Flash-приложения
• Веб-приложение, работающее в браузере Edge (устарел)

• боты Enterprise 11 или Enterprise 10 могли запускать макрос Microsoft Excel из файла Microsoft
Excel, доступного в файле XLSTART, если этот макрос вызывался из другого файла Excel, не
содержащего этот макрос. После миграции эти боты не могут запускать макросы, которые
доступны в другом файле Excel.

• Символ стрелки не отображается в Automation 360 Bot editor.
Когда символ стрелки используется в боты Enterprise 11 или Enterprise 10, Bot editor не
отображает никаких символов после миграции, за одним исключением. Исключение: когда
символ используется в нескольких командах IF/ELSE, Bot editor отображает переменную
$String:FormFeed$ вместо символа стрелки.

Неподдерживаемые функции с обходным решением

Вы можете выполнить миграцию боты со следующими функциями, если вы обновите их на основе
указанного обходного решения.
• If you have created triggers, indexes, views and such custom Database objects in addition to the

existing standard objects created in the Enterprise 11 Control Room, you might not be able to restore
the exported data to Cloud using the Cloud Migration Utility. If you need help to identify such objects,
contact Automation Anywhere support: Open a support case (A-People login required).
Обходное решение. Disable the additionally created Database objects before exporting data to the
Cloud.

• In Enterprise 11, if боты were using a window title value or variable that contained leading spaces,
after migration, the боты will be unable to select the corresponding window.
Обходное решение. Remove the leading spaces from the window title value or variable and then
run the боты.

• When you use the Средство записи to capture an object, select HTML Tag, HTML InnerText, and
HTML type properties in Search Criteria, or migrate a бот with similar properties selected in Search
Criteria, the бот fails to identify or locate the object and perform the selected action.
Обходное решение. Modify the DomXpath according to the controls you capture or add more
properties in Search Criteria.

• When your бот has some error, you add the Try/Finally block around those actions and insert one
more action in the Finally block. When you save and run the бот, you will see the Бот error dialog
shows the wrong error line number within the Finally block.
Обходное решение. If you are using Try and Finally without using Catch action, the Бот error
dialog will not show the correct line number. Instead, use Try/Catch, the Try action handles the
error and sends execution to Catch with line number and description. This would give the correct line
number within the Finally block.
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• Примечание. Issue applies only to v.22 and earlier (as this is fixed in v.23, see Migration of non-
credential vault variables). Команда Запустить логику, которая использует переменные учетных
данных в качестве входных данных для логики MetaBot
Обходное решение. Боты, использующие команду Запустить логику, которая передает
атрибуты Credential Vault из TaskBot в логику MetaBot, могут быть перенесены в Automation
360. Имя учетных данных и имя атрибута отображаются в полях в соответствующей строке
перенесенного бот.
Если вы выполнили миграцию с использованием восстановленной базы данных Enterprise
11, эквивалент ячейка будет создан в Automation 360 для переменных учетных данных,
используемых в бот Enterprise 11.
Выберите один из следующих вариантов, чтобы успешно запустить перенесенные боты.
• Вариант 1. Передайте переменные типа «Компонент учетных данных».

1. Создайте переменную типа «Компонент учетных данных» в дочерних боты в качестве
входной переменной.

2. В action Запустить в пакет TaskBot родительского бот обновите поля входных значений,
чтобы использовать атрибуты Credential Vault для переменной типа учетных данных,
созданной для дочернего бот (в соответствии с логикой MetaBot).

• Вариант 2. Передайте значения учетных данных в качестве глобального значения.
1. Создайте глобальное значение в Automation 360 для учетных данных, используемых в

команде Запустить логику в Enterprise 11.
2. В action Запустить в пакет TaskBot родительского бот обновите поля входных значений,

чтобы использовать глобальные значения для переменной типа учетных данных,
созданной для дочернего бот (в соответствии с логикой MetaBot).

Если вы не использовали восстановленную базу данных Enterprise 11 при установке Automation
360, перед выполнением шагов, представленных выше, вам потребуется создать необходимую
ячейку для переменных учетных данных, используемых в бот Enterprise 11.

Note:  Automation 360 обеспечивает повышенный уровень безопасности, позволяя присваивать
атрибуты Credential Vault только переменным типа учетных данных. Это ограничивает любую
небезопасную работу с атрибутами Credential Vault, если они присвоены переменным типа не
учетных данных.

• When you create DLLs with different functions, if you use the same filename for DLLs and add them to
multiple MetaBots, after migration, if a TaskBot is using the Логика of these MetaBots, an error occurs
during execution.
The error occurs because the DLL sessions are based on the DLL filenames, and only the session of the
first DLL will be active during execution. Any function called from subsequent DLLs will not be present
in the first DLL session that is active.
For example, consider that MetaBot1 is using a DLL that has function1 and MetaBot2 is using a DLL
that has function2, and both the DLLs have the same filename test.dll. After migration, when
you run a TaskBot that uses MetaBot1 Логика and MetaBot2 Логика, the DLL session of MetaBot1
Логика is activated and function1 runs successfully. However, when the MetaBot2 Логика is run, the
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corresponding DLL is not activated because the session with the same DLL filename is already active,
and function2 is not present in the DLL of MetaBot1 Логика, which results in an error.
Обходное решение. Depending on your requirements, you can perform one of the following
workarounds:
• Before migrating the боты, ensure that you rename the DLL filename of one of the DLLs, update the

references to the DLL function in MetaBots Логика, and then migrate the боты.
• After migrating the боты, change the session name in the Create DLL session box of the Open

DLL action and then update the same DLL session name in the related If action for the DLL
Session does not exists condition and the Run DLL action.

• In Enterprise 11, if a MetaBot was using Microsoft.Exchange.WebServices.dll to use
Microsoft Exchange services, after migration, when you use the Get DLL details option in
the DLL Run function, an error is encountered. The error is because, in Automation 360, the
Microsoft.Exchange.WebServices.dll is not automatically installed in the global assembly
cache (GAC) on your device.
Обходное решение. You must manually install the Microsoft.Exchange.WebServices.dll in
GAC on your device and then use the Get DLL details option.
См. раздел How to: Install an assembly into the global assembly cache .

• In Enterprise 11, if a бот was using the Записать в файл action and you entered text greater than
1000 characters in the Enter text to log field, then after migration, the бот will encounter an error.
Обходное решение. Ensure that the you configure the text as a variable, and then use this variable
in the Enter text to log field instead of entering the static text.

• In Enterprise 11, if you used the Цикл action to open the same Excel sheet multiple times without
closing it, after migration, an error occurs. The error occurs because, in Automation 360, only one Excel
session can be active at a time.
Обходное решение. In the Цикл action, ensure that you use the Close action to close the Excel
session before opening the Excel sheet again with the same session name.

• In Enterprise 11, if боты were using the String > Replace action to find a carriage return line feed
(CRLF) character and replace it with another character, after migration, the output might not be the
same as the output seen in Enterprise 11.
Обходное решение. In the Find string option, instead of the Enter (LF) variable, use the Newline
(CRLF) variable.

• After migration, боты that were using the Записать в файл action to log files are using the LF
character instead of the CRLF character for new lines.
Обходное решение. Use the $String:Newline$ variable to use the CRLF character in the
migrated боты.

• If a MetaBot Логика (for example, Логика A) is referenced to a TaskBot or another MetaBot Логика
and if Логика A was renamed or moved from one logic folder to another within the same MetaBot, after
migration, the TaskBot or MetaBot Логика does not work when it calls for Логика A.
Обходное решение. In the TaskBot or MetaBot Логика which calls for Логика A, update the name
or path to reference to Логика A.

• If a бот is using the Browser > Download files action to download files from a URL, some files
whose URLs have special characters or require Windows native authentication access might not
download properly.
Обходное решение. Use the Browser > Open action instead.

• Automated migration to Automation 360 Cloud.
Обходное решение. Для миграции в экземпляр с поддержкой облака можно использовать
ручной процесс. См. раздел Подготовка миграции с Enterprise 11 на Automation 360 с поддержкой
облака on page 1211.
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• When you insert XML > Insert node as an attribute using a variable, the бот migration might fail.
Обходное решение. Insert the attribute by providing the direct value instead of a variable.

• When you run migrated боты that open URL without the protocol information (such as http, https, or
file), the web page might not open properly.
Обходное решение. Ensure that you add the appropriate protocol information to the URL.

• If a MetaBot Логика was using a DLL file that used classes without a namespace, after migration, any
TaskBot that uses the MetaBot Логика will not work.
Обходное решение. Manually update the DLL file to include namespace for classes.

• After migrating боты, an error is seen when using FTP actions on боты that are using comma in the
filenames and when using the Delete files and Delete folder FTP actions on боты that are using colon in
the filenames.
Обходное решение. Ensure that you remove comma in the filenames before using the FTP actions
and colon in the filenames before using the Delete files and Delete folder FTP actions.

• If a bot was using the Send action to send an email with attachments where the path for the
attachments were variables, the bot will either fail to execute or ignore the attachment.
Обходное решение. Replace variables with the paths for the attachments.

• Для боты Enterprise 11 или Enterprise 10 после миграции возникает ошибка, когда эти боты
используют команду Запустить логику для запуска логики MetaBot, а расположение логики
указано вплоть до папки, непосредственно содержащей эту логику. Например, предположим,
что вы хотите запустить логику Logic1, которая доступна в расположении D:Metabots\Logics
\Finance. Если вы указываете только D:Metabots\Logics\Finance, а не путь логики целиком
(D:Metabots\Logics\Finance\Logic1), происходит ошибка.
Обходное решение. Перед миграцией измените путь всей логики MetaBot на полный путь в
боты Enterprise 11 или Enterprise 10.

• MetaBots Enterprise 11 или Enterprise 10, которые используют переменную учетных данных для
передачи числового значения в качестве входного значения в функцию DLL.
Обходное решение.
1. Обновите функцию DLL для использования входного параметра строкового типа.
2. Удалите команды из MetaBots, которые передают входной параметр числового типа в

функцию DLL.
3. Добавьте команды в MetaBots для передачи входных параметров строкового типа в функцию

DLL.
4. Выполните миграцию соответствующих TaskBots и MetaBots.

• Если вы выполняете миграцию в Automation 360 Cloud и настроили SAML в качестве типа
аутентификации в Enterprise 11, то процесс миграции изменит тип аутентификации на тип
аутентификации базы данных Control Room для перенесенной Control Room в Automation 360.
Обходное решение. Чтобы настроить SAML в качестве типа аутентификации для Cloud Control
Room после миграции, выполните следующие действия.
1. Удалите пользователя, который использовался для настройки SAML в Enterprise 11 из

Automation 360.
2. Создайте другого пользователя с необходимыми разрешениями и используйте его для

настройки SAML в Automation 360.

• Applicable to v.24 and earlier:Migration from Enterprise 10 to Automation 360 Cloud.
Обходное решение. Выполните миграцию на версию Enterprise 11, которая поддерживается
для миграции в Automation 360 Cloud, и затем выполните миграцию в Automation 360 Cloud.
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• Для боты Enterprise 11, которые используют Exchange Web Service (EWS) для отправки
электронной почты с помощью команды Отправить сообщение эл. почты, после миграции в
Automation 360 возникает ошибка.
Обходное решение. Создайте следующие глобальные значения в Automation 360 и обновите
перенесенные боты для использования EWS во всех действиях:
• AAE_EmailSettings_auth
• AAE_EmailSettings_host
• AAE_EmailSettings_port
• AE_EmailSettings_ssl

Значения для этих глобальных значений должны быть такими же, какие указаны в Enterprise 11.
• Для команды Цикл или Если, использующая условия даты для сравнения дат в разных форматах,

после миграции возникает ошибка. Например, дата в формате MM/dd/yyyy не работает с датой в
формате MM/dd/yyyy hh:mm:ss.
Обходное решение. Обновите даты с разным форматом до одинакового формата.

• бот не может использовать переменную или объект, содержащий данные размером более
64 Кбайт. Например, если вы записали таблицу с веб-сайта с помощью команды Object Cloning
и записанный объект содержит данные размером более 64 Кбайт. Для Боты, содержащих такие
объекты, после миграции возникает ошибка.
Обходное решение. Удалите ненужные данные или скопируйте данные в файл CSV или
текстовый файл и используйте action Чтение из пакет CSV/TXT.

• Миграция не выполняется для действий, для которых значение Credential Vault отсутствует в
Control Room.
Обходное решение. Создайте значение Credential Vault в Automation 360 перед миграцией и
запустите миграцию снова с помощью Bot Migration Wizard.

Миграция боты с состоянием «Неприменимо»

В отчетах Bot Scanner состояние боты, которые содержат неподдерживаемые команды и не могут
быть перенесены, обозначается как Неприменимо. Вы можете выполнить миграцию таких боты,
изменив их на вашем компьютере Enterprise 11 или Enterprise 10, как указано в следующей таблице.

Сообщение Миграция ботов пока не поддерживается из-за того, что дочерние боты
используют неподдерживаемые команды.

Описание Невозможно перенести дочерний бот, использующий команду, которая
в настоящее время не поддерживается для миграции. В результате,
родительские боты, использующие этого дочернего бот, также не могут быть
перенесены.

Действие Чтобы перенести родительские боты, удалите связи с дочерним бот из
родительского бот. Затем перенесите этот родительский бот.
Чтобы просмотреть неподдерживаемые команды, которые используются
в дочерних боты, перейдите к списку боты, которые не могут быть
перенесены, и щелкните по имени дочернего бот.

Сообщение Миграция «Клонирование объектов» с «HTML (Edge)» пока не
поддерживается
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Описание Браузер Microsoft Edge (устарел) не поддерживается в Automation 360,
поэтому миграция боты, настроенных с помощью этого браузера, не
поддерживается.

Действие Обновите боты Enterprise 11, используя другие поддерживаемые браузеры,
такие как Google Chrome, Firefox, Internet Explorer или Microsoft Edge
Chromium.

Сообщение Миграция MetaBot не поддерживается. Файл экрана не существует.
Исправьте бот и повторите попытку.

Описание Логика MetaBot относится к экрану, который не существует в MetaBot.

Действие Чтобы выполнить миграцию MetaBot, либо добавьте экран заново, либо
удалите ссылки на несуществующие экраны.

Сообщение Не поддерживается миграция команды «Операция переменной», когда типы
переменных не совпадают. Исправьте бот и повторите попытку.

Описание бот Enterprise 11 или Enterprise 10 использует команду Операция
переменной, когда типы используемых переменных не совпадают.

Действие Обновите команду Операция переменной в боты Enterprise 11 или
Enterprise 10, чтобы обеспечить одинаковый тип связанных переменных.

Сообщение Не поддерживается миграция команды «Операция переменной», когда
переменная не существует. Исправьте бот и повторите попытку.

Описание бот Enterprise 11 или Enterprise 10 связан с несуществующей переменной в
команде Операция переменной.

Действие Создайте переменную с таким же именем и типом или удалите команду,
которая связана с несуществующей переменной.

Сообщение Не поддерживается миграция команды «Если», когда переменная не
существует. Исправьте бот и повторите попытку.

Описание бот Enterprise 11 или Enterprise 10 связан с несуществующей переменной в
команде Если.

Действие Создайте переменную с таким же именем и типом или удалите команду,
которая связана с несуществующей переменной.

Сообщение Не поддерживается миграция команды «Иначе/если», когда переменная не
существует. Исправьте бот и повторите попытку.
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Описание бот Enterprise 11 или Enterprise 10 связан с несуществующей переменной в
команде Иначе/если.

Действие Создайте переменную с таким же именем и типом или удалите команду,
которая связана с несуществующей переменной.

Сообщение Не поддерживается миграция команды «Цикл», когда переменная не
существует. Исправьте бот и повторите попытку.

Описание бот Enterprise 11 или Enterprise 10 связан с несуществующей переменной в
команде Цикл.

Действие Создайте переменную с таким же именем и типом или удалите команду,
которая связана с несуществующей переменной.

Сообщение Не поддерживается миграция «Выполнить задачу» с путем бота,
определенным с помощью «AAApplicationPath», за которым не следует
действительный путь к папке репозитория. Исправьте путь бота задач в боте
11.x и выполните миграцию снова.

Описание бот Enterprise 11 или Enterprise 10 использует недопустимый путь в команде
Выполнить задачу дочернего бот.

Действие Для миграции бот измените бот Enterprise 11, чтобы после
«AAApplicationPath» шел действительный путь дочернего бот.

Сообщение Не поддерживается миграция «If - TaskSuccessful» с путем бота,
определенным с помощью «AAApplicationPath», за которым не следует
действительный путь к папке репозитория. Исправьте путь бота задач в боте
11.x и выполните миграцию снова.

Описание бот Enterprise 11 или Enterprise 10 использует недопустимый путь в условии
Если > Задача успешно выполнена дочернего бот.

Действие Обновите бот Enterprise 11 или Enterprise 10, чтобы после
«AAApplicationPath» шел действительный путь дочернего бот и затем
соответствующая структура папок.

Сообщение Не поддерживается миграция «If - TaskUnsuccessful» с путем бота,
определенным с помощью «AAApplicationPath», за которым не следует
действительный путь к папке репозитория. Исправьте путь бота задач в боте
11.x и выполните миграцию снова.

Описание бот Enterprise 11 или Enterprise 10 использует недопустимый путь в условии
Если > Задача не выполнена дочернего бот.
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Действие Обновите бот Enterprise 11 или Enterprise 10, чтобы после
«AAApplicationPath» шел действительный путь дочернего бот и затем
соответствующая структура папок.

Сообщение Не поддерживается миграция «ElseIf - TaskSuccessful» с путем бота,
определенным с помощью «AAApplicationPath», за которым не следует
действительный путь к папке репозитория. Исправьте путь бота задач в боте
11.x и выполните миграцию снова.

Описание бот Enterprise 11 или Enterprise 10 использует недопустимый путь в условии
Иначе/если > Задача успешно выполнена дочернего бот.

Действие Обновите бот Enterprise 11 или Enterprise 10, чтобы после
«AAApplicationPath» шел действительный путь дочернего бот и затем
соответствующая структура папок.

Сообщение Не поддерживается миграция «ElseIf - TaskUnsuccessful» с путем бота,
определенным с помощью «AAApplicationPath», за которым не следует
действительный путь к папке репозитория. Исправьте путь бота задач в боте
11.x и выполните миграцию снова.

Описание бот Enterprise 11 или Enterprise 10 использует недопустимый путь в условии
Иначе/если > Задача не выполнена дочернего бот.

Действие Обновите бот Enterprise 11 или Enterprise 10, чтобы после
«AAApplicationPath» шел действительный путь дочернего бот и затем
соответствующая структура папок.

Сообщение Не поддерживается миграция команды «Операция переменной», которая
сбрасывает системную переменную «$WorkItemResult$».

Описание Сброс системной переменной $WorkItemResult$ не поддерживается для
команды Операция переменной.

Действие Используйте операцию Строка > Присвоить и присвойте пустую строку
системной переменной $WorkItemResult$ вместо сброса.

Сообщение Миграция «Окна - закрыть все открытые окна» пока не поддерживается.

Описание Если вы использовали команду Закрыть с выбранным параметром Все
открытые окна в бот, вы не можете выполнить миграцию этого бот.

Действие Обновите бот Enterprise 11 или Enterprise 10, чтобы он не использовал
параметр Все открытые окна перед миграцией.
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Сообщение Миграция «If - ObjectProperties» с полем
«OCObjectPlay_PropertyInfo_ReviewMessage» типа «Строка» пока не
поддерживается.

Описание бот Enterprise 11 или Enterprise 10 использует объект в команде Если >
Свойства объекта с одним из свойств размером более 64 Кбайт.

Действие Чтобы выполнить миграцию этого бота, выполните одно из следующих
действий.
• Удалите значение свойства, размер которого превышает 64 Кбайт, в

команде Если > Свойства объекта.
• Сохраните значение свойства, превышающее 64 Кбайт, в текстовый файл.

Затем создайте переменную, которая считывает значение из этого файла.
Присвойте эту новую переменную соответствующему свойству в команде
Если > Свойства объекта.

Сообщение Миграция «ElseIf - ObjectProperties» с полем
«OCObjectPlay_PropertyInfo_ReviewMessage» типа «Строка» пока не
поддерживается.

Описание бот Enterprise 11 или Enterprise 10 использует объект в команде
Иначе/если > Свойства объекта с одним из свойств размером более
64 Кбайт.

Действие Чтобы выполнить миграцию этого бота, выполните одно из следующих
действий.
• Для миграции бота удалите значение свойства, размер которого

превышает 64 Кбайт, в команде Иначе/если > Свойства объекта.
• Сохраните значение свойства, превышающее 64 Кбайт, в текстовый файл.

Затем создайте переменную, которая считывает значение из этого файла.
Присвойте эту новую переменную соответствующему свойству в команде
Иначе/если > Свойства объекта.

Сообщение Миграция «Loop.Condition - ObjectProperties» с полем
«OCObjectPlay_PropertyInfo_ReviewMessage» типа «Строка» пока не
поддерживается.

Описание бот Enterprise 11 или Enterprise 10 использует объект в команде Цикл while
> Свойства объекта с одним из свойств размером более 64 Кбайт.
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Действие Чтобы выполнить миграцию этого бота, выполните одно из следующих
действий.
• Для миграции бота удалите значение свойства, размер которого

превышает 64 Кбайт, в команде Иначе/если > Свойства объекта.
• Сохраните значение свойства, превышающее 64 Кбайт, в текстовый файл.

Затем создайте переменную, которая считывает значение из этого файла.
Присвойте эту новую переменную соответствующему свойству в команде
Иначе/если > Свойства объекта.

Различия функций Automation 360 и Enterprise 11/Enterprise 10
Review how some features and functionalities, such as folder structure, бот deployment, пакеты,
variables, and MetaBots, are different in Automation 360 as compared with Enterprise 11 and Enterprise
10.

Структура папок

Структура папок, в которой хранятся боты (TaskBots и MetaBots), отличается в Automation 360 по
сравнению с Enterprise 11 и Enterprise 10.

Структура папок Automation 360 The боты (TaskBots and MetaBots) are available
in the Automation > Bots. Боты, которые
переносятся из Enterprise 11 или Enterprise 10,
доступны в общей рабочей области.
The following image shows the folder structure in
Automation 360

Структура папок Enterprise 11 и Enterprise
10

Боты (TaskBots only) are available in the My
 Tasks folder (Automate > Tasks > My Tasks)
and MetaBots are available in the My MetaBots
folder.
На следующем изображении показана структура
папок в Enterprise 11:
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Развертывание Бот

• Enterprise 11. Когда активен бот с низким приоритетом, а развертывается бот с высоким
приоритетом, система приостанавливает работу бот с низким приоритетом и запускает бот
с высоким приоритетом. После запуска бот с высоким приоритетом работа бот с низким
приоритетом возобновляется.

• Automation 360. Приоритет боты проверяется при развертывании. Когда боты ставятся в
очередь для пользователя Bot Runner, боты с более высоким приоритетом развертываются
раньше, чем боты с низким приоритетом. Однако если бот с более низким приоритетом уже
запущен, боты с более высоким приоритетом развертываются только после завершения работы
бот с более низким приоритетом.
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Пакеты

Для большинства команд Enterprise 11 или Enterprise 10 в Automation 360 доступны аналогичные
или эквивалентные actions и пакеты. However, the behavior of some of the Automation 360commands is
different compared with those in Enterprise 11 or Enterprise 10.
• Automation 360 is created afresh to support not only the current but also the future automation needs

of modern enterprises. Accordingly, Automation 360 is built to meet important objectives, such as
providing the following features:
• A standardized, predictable, and scalable platform
• Consistent user experience
• Improved flexibility and security

With Automation 360, we aim to provide these features by employing industry-standard exception
handling, rich support for dedicated data types, and so on.
Because Automation 360 is created afresh, some of the Enterprise 11 capabilities that have been
redesigned in Automation 360 might not have a directly corresponding Automation 360 feature.
However, to ensure that the migrated боты produce output that is identical to that produced by their
corresponding Enterprise 11 боты, we have mapped Enterprise 11 commands to their corresponding
actions in Automation 360.
In instances where a direct mapping between an Enterprise 11 command and an Automation 360 action
is unavailable, we have used "expressions" to ensure that the migrated боты produce output that is
identical to that produced by their corresponding Enterprise 11 боты, without requiring you to manually
update the боты.

Note:  The usage of expressions leads to more number of lines and additional variables in the migrated
боты as compared to their corresponding Enterprise 11 боты.

For information about expressions, see Legacy Automation пакет on page 1682.
• Для команды Enterprise 10/Enterprise 11, использующей поле заголовка окна, которое настроено

с помощью пользовательской переменной, миграция бот осуществляется путем добавления
действия Установить заголовок непосредственно над соответствующей командой. Automation
360 не позволяет использовать пользовательские переменные в поле Заголовок окна.
Используйте действие Установить заголовок для получения того же поведения.

• Когда в Enterprise 11 бот содержит более одной команды с выбранным параметром Изменить
размер окна, размер окна изменяется до значений, заданных первой командой. В Automation
360 размер окна изменяется каждый раз, когда бот обнаруживает action с выбранным
параметром Изменить размер окна. Это гарантирует, что во время выполнения размеры окна
каждого action будут соответствовать размерам, настроенным для action. Это позволит боту
быстрее находить объекты.

• В Enterprise 11 или Enterprise 10 циклическая индексация таблицы начинается с 1 и
увеличивается на 1. Automation 360 запускает индексацию с 0 и увеличивает ее на 1.

• В процессе миграции переносятся команды «ЕСЛИ» и «Цикл», которые содержат несколько
условий переменной.
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• Отключенные команды переносятся на основе различных шаблонов кодирования следующим
образом.
• Отдельно отключенная команда (с ошибкой валидации или без нее) переносится как

отключенное действие. Все действия отключаются, если одна отключенная команда
переносится в несколько действий Automation 360.

• Отключенная команда Обработка ошибок переносится в отключенный блок «Попробовать и
выявить», включая все остальные действия в зависимости от конфигурации.

• Отключенная команда Цикл переносится в отключенное действие Цикл в Automation 360.
• Disabled If command is migrated as a comment so that the migrated бот returns the same result as

that returned by the corresponding Enterprise 10 or Enterprise 11 бот.

• В Enterprise 11 или Enterprise 10 некоторые команды операций строки используют специальные
символы Tab, Enter и Separator. В Automation 360 эти символы являются системными переменными
в пакете «Строка».

Enterprise 10/Enterprise 11 Automation 360

[Tab] $String:Tab$

[Enter] $String:Enter$

[Separator] $String:Separator$

См. раздел Строка пакет on page 1895.
• Enterprise 11 или Enterprise 10 предоставляет различные предустановки для выбора заголовка

окна, которые переносятся в соответствующие предустановки в Automation 360.

Параметры Enterprise
10/Enterprise 11

Параметры Automation 360

Текущее активное окно Текущее активное окно

Рабочий стол • Для команды Вставить щелчок мыши
используйте параметр Экран для заголовка
окна.

• Для команды Вставить клавишу используйте
параметр Текущее активное окно.

• For Screen > Capture area, use the Screen for
window title option.

• Для команды Захватить рабочий стол команды
Screen Capture используйте действие Захватить
область пакет Экран с параметром Экран,
выбранным из списка на вкладке Приложение.

Обои Рабочий стол

Панель задач Панель задач

Сопоставление пакетов для миграции on page 1258

Переменные

Для большинства пользовательских, системных переменных Enterprise 11 или Enterprise 10, а также
переменных учетных данных в Automation 360 доступны аналогичные или эквивалентные системные
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переменные. Поведение некоторых переменных Enterprise 11 или Enterprise 10 отличается от
поведения в Automation 360.
• Для каждой переменной, переданной бот Enterprise 11 или Enterprise 10 в качестве входных

данных, в перенесенном бот в Automation 360 добавляется строка. Например, если в бот
Enterprise 11 в качестве входных данных передается переменная 100, после миграции бот
появится 100 новых строк.

• In Enterprise 11 or Enterprise 10, you can use the Session Name field in paired commands to specify
a session name as both a static value and a variable value. For example, you can specify a session
name to open a file or establish a connection. You can then use that same session name as a variable
value in a Цикл command. However, migrated боты differentiates between a static value and a variable
value, and handle the values differently after migration. As a result, after you migrate these боты to
Automation 360, you must update the bot to use the correct output Dataset variables in the Цикл
command (which is aligned with the Open file session variable). For migrated боты, we recommend
that you configure the session name as a static value or a variable value in all the instances.

• Команды Enterprise 11 или Enterprise 10, которые хранят возвращаемые значения в системной
переменной $Clipboard$, не поддерживаются в Automation 360. Когда для миграции боты
используется эта функция, в процессе временной переменной присваиваются значения, а затем
путем добавления действия Копировать в к пакету Буфер обмена значение присваивается
системной переменной $System:Clipboard$ Automation 360.

• Некоторые команды возвращают значения переменным для дальнейшей обработки. В Enterprise
11 или Enterprise 10 пользователи могут хранить эти значения в различных типах переменных, в
то время как в Automation 360 эти значения хранятся только в определенном типе переменных.
Например, если команда возвращает значение в массив для определенной ячейки, в Automation
360 оно сохраняется во временной переменной строки. В следующем действии это временное
значение сохраняется в фактическую переменную массива, чтобы убедиться, что логика
выполнения бот не нарушена.

• В Automation 360 одиночный знак доллара ($) зарезервирован для использования в Automation
Anywhere, поэтому все пользовательские записи одиночного знака доллара автоматически
заменяются двумя знаками доллара ($$). Например, если существует текстовое поле «Pay
$5.00», в Automation 360 оно будет преобразовано в «Pay $$5.00» для верного отображения
пользователям.

• В боты Enterprise 11 или Enterprise 10 можно использовать переменную для указания дочернего
бот, которого необходимо запустить. В Automation 360 путь задачи обновляется до папки Bots. В
следующей таблице приведены несколько примеров:

Enterprise 11 или Enterprise 10 Automation 360

D:\My Documents
\AAE_V11\Automation Anywhere
 Files\Automation Anywhere\My
 Tasks\Migration\$bot_name$

Bots\My Tasks\Migration\$bot_name
$

$AAApplicationpath$\Automation
 Anywhere\My Tasks\Migration\
$bot_name$

Bots\My Tasks\Migration\$bot_name
$

D:\$UserName$\My Documents
\AAE_V11\Automation Anywhere
 Files\Automation Anywhere\My
 Tasks\Migration\$bot_name$

Bots\My Tasks\Migration\$bot_name
$

D:\My Documents
\AAE_V11\Automation Anywhere
 Files\Automation Anywhere\
$bot_path$\$bot_name$

Bots\My Tasks\$bot_path$\
$bot_name$
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Сопоставление переменных для миграции on page 1293

Поддержка переменных on page 736

MetaBots

MetaBots недоступны в Automation 360. При выполнении миграции MetaBots Enterprise 11 или
Enterprise 10 переносятся в эквивалентные TaskBots Automation 360. Эти TaskBots обладают теми же
возможностями, что и MetaBots.
В процессе миграции библиотеки DLL и логика переносятся в эквивалентные боты. Команда
Запустить логику преобразуется в действие Запустить пакета TaskBot. Библиотеки DLL в
MetaBots используют команду Выполнить для запуска функции из этой библиотеки DLL. После
миграции в Automation 360 каждая команда Выполнить преобразуется в действия Открыть,
Выполнить функцию и Закрыть в пакете DLL. Информация о том, какую функцию запускать
из библиотеки DLL, какие параметры использовать, и другие подробности в команде Выполнить
переносятся в команду Запустить. MetaBots с библиотеками DLL, которые используют переменные
учетных данных типа строки, символа и байтовых данных, можно перенести в Automation 360.
До Automation 360 v.17 переменная словаря использовалась для предоставления входных
параметров в перенесенных боты, используемых для добавления дополнительных шагов в бот.
Начиная с v.17, переменная Entrylist используется для предоставления входных параметров в
перенесенном бот. Это уменьшает количество шагов, добавляемых к перенесенному бот.

Как выполняется миграция MetaBots on page 1234

Обзор Bot Scanner
Bot Scanner анализирует боты (TaskBots и MetaBots), созданные в Control Room Enterprise 10 или
Enterprise 11. The scanner generates a report summarizing the number of боты, commands, and variables
that are ready for migration and those not yet supported for migration, and provides a recommendation on
whether you are ready for migration.
Вы также можете использовать Bot Scanner для сканирования и определения боты, которые
используют Internet Explorer и которые можно преобразовать для поддерживаемого браузера.
Подробнее см. в разделе Сканирование боты, которые используют Internet Explorer on page 1168.

Note:  Версия Bot Scanner обновляется с каждым выпуском Automation 360. Используйте последнюю
версию Bot Scanner для отслеживания команд и переменных, которые поддерживаются для
миграции в каждом обновлении Automation 360. Сканер получает информацию о компонентах
Automation Anywhere, используемых клиентами, и определяет приоритеты поддержки этих
компонентов для миграции.

Рекомендации по использованию Bot Scanner

• Перед сканированием боты убедитесь, что для миграции используется поддерживаемая версия
Control Room в Enterprise 10 или Enterprise 11.

Поддерживаемые для миграции версии Control Room on page 1143
• Для запуска Bot Scanner не нужно устанавливать Automation 360, но требуется доступ к

репозиторию Enterprise 10 или Enterprise 11.
• Необходимо запустить Bot Scanner перед выполнением любых шагов миграции.
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Работа Bot Scanner

Bot Scanner считывает содержимое Enterprise 10 или Enterprise 11 и предоставляет краткий отчет
для анализа. Сканер предоставляет рекомендацию о том, следует ли выполнять миграцию сейчас,
а также генерирует расчетное время доступности (ETA), то есть когда неподдерживаемые команды
будут доступны в Automation 360.

Note:  Bot Scanner не выполняет миграцию боты или какие-либо другие действия. Если вы
не готовы к миграции, то Bot Scanner определяет причины, по которым боты не могут быть
перенесены.

боты (файлы .atmx и .mbot) сканируются в указанном вами расположении, а сводный отчет
содержит следующую информацию:
• Количество отсканированных боты
• Количество боты, которые можно и нельзя перенести в Automation 360
• Команды и переменные, которые используются в отсканированных боты и поддерживаются в

Automation 360
• Команды, которые переносятся в Automation 360 с изменениями, которые необходимо проверить

Note:  Bot Scanner формирует сводный отчет в формате HTML и отдельный отчет для каждого бот в
формате XML.

Отчеты Bot Scanner

Bot Scanner генерирует следующие отчеты, чтобы понять, следует ли начать миграцию.

Продолжайте миграцию Эта рекомендация отображается, когда 95%
или более 95% боты можно перенести.
Поскольку большинство боты готово к миграции,
вы можете выполнить миграцию. Возможно,
придется выполнить некоторые действия до или
после миграции, чтобы перенести оставшиеся
боты.

Ожидайте возможности миграции Эта рекомендация отображается, когда можно
перенести только менее 95% боты. В этом
случае необходимо запустить последнюю версию
Bot Scanner, доступную в следующем выпуске
Automation 360, для оценки возможности
миграции.

Совместное использование отчета Bot Scanner для улучшения работы

Вы можете улучшить процесс миграции в Automation 360 за счет обмена отчетами, созданными
Bot Scanner. Эти отчеты помогают нашей команде разработчиков сосредоточиться на поддержке
компонентов, которые чаще всего используются нашими клиентами.

Important:  Конфиденциальность общих отчетов сохраняется. Информация, позволяющая
установить личность (PII), не используется, а перед отправкой отчетов вы можете их просмотреть.
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Для получения более подробной информации обратитесь к менеджеру-консультанту (CSM) или
менеджеру по работе с партнерами (PEM).

Сканирование боты, которые используют Internet Explorer

Вы можете использовать Bot Scanner для сканирования боты Internet Explorer, которые требуется
преобразовать для поддерживаемого браузера.
Чтобы преобразовать боты, которые используют Internet Explorer, Bot Scanner сканирует все боты и
определяет, какие используют Internet Explorer, поэтому вам не придется делать это вручную. Далее
Bot Scanner создает отчет, содержащий сведения о количестве боты, которые можно преобразовать,
и боты, которые преобразовать нельзя, а также сообщения о результатах проверки.
Для получения дополнительной информации см. Analyze report for Internet Explorer боты on page 788 и
Сообщения о преобразовании или сканировании Internet Explorer on page 1351.

Scanning боты that use basic authentication

You can use Bot Scanner to scan боты that are using basic authentication in the Эл. почта package and
Эл. почта trigger.
Bot Scanner scans all боты and identifies those that use basic authentication so that you do not have to
identify them manually. The Bot Scanner then generates a report that provides details on the number of
боты that can be updated, along with review messages.
Для получения дополнительной информации см. Scan Automation 360 боты for Эл. почта action with Basic
authentication usage on page 808 и Basic authentication scanning messages on page 811.

Scan Enterprise 11 or 10 боты using Bot Scanner
Перед миграцией в Automation 360 важно проверить готовность боты к миграции. Просканируйте
боты с помощью Bot Scanner и проанализируйте созданный отчет для получения информации о
командах и переменных, используемых в этих боты, а также сведений о том, сколько из команд и
переменных поддерживается для миграции.
Проверьте свои системные требования для использования Bot Scanner.
• Требования к аппаратному обеспечению

Процессор 2,66 ГГц или больше (64-битный)

ОПЕРАТИВНАЯ ПАМЯТЬ 2 Гбайт или больше

Дисковое пространство 200 Мбайт

• Требования к программному обеспечению
Операционные системы: Windows 7 или более поздняя версия (32- и 64-разрядная версии)
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Вы также можете использовать Bot Scanner для сканирования и определения боты, которые
используют Internet Explorer и которые можно преобразовать для поддерживаемого браузера.
1. Загрузите последнюю версию Bot Scanner с сайта поддержки Automation Anywhere.

a) Перейдите в A-People Downloads page (Login required).
b) Щелкните ссылку Automation 360 v.xx <номер_сборки>.

xx в ссылке — номер выпуска. Например, Automation 360 v.21.
c) Щелкните папку Installation Setup.
d) Щелкните ZIP-файл AAE Bot Scanner, а затем Загрузить на панели инструментов.

See the following video on how to download Bot Scanner:
2. Извлеките файлы из загруженного ZIP-файла и дважды щелкните AAE_Bot_Scanner.exe.

Note:  Проверьте, что вы сохранили файл AAE_Bot_Scanner.exe в расположении, не
содержащем двухбайтовых символов. В противном случае при запуске Bot Scanner возникнет
ошибка.

Можно использовать Bot Scanner для сканирования боты, которые используют Internet Explorer.
Сканер создает отчет, содержащий сведения о количестве боты, которые можно преобразовать, и
боты, которые нельзя преобразовать в поддерживаемом браузере.
3. В диалоговом окне Automation Anywhere Bot Scanner выберите один из следующих

вариантов:
• Миграция в Automation 360
• Миграция + Боты, использующие Internet Explorer
• Боты, использующие Internet Explorer

Второй и третий варианты предоставляют статистику использования Internet Explorer, которая
поможет вам преобразовать боты Internet Explorer в поддерживаемый браузер.
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4. В диалоговом окне Automation Anywhere Bot Scanner введите расположение папки,
содержащей боты, которые вы хотите проанализировать, в поле Выберите путь к
репозиторию.

Important:  Вы должны создать копию репозитория Control Room и указать расположение
скопированной папки вместо фактической папки репозитория.

a) Скопируйте репозиторий Control Room.
Например, если текущее расположение репозитория — C:\ProgramData
\AutomationAnywhere\Server Files\Default\Automation Anywhere, вы должны
скопировать папку Automation Anywhere.

b) Вставьте скопированный репозиторий во временное расположение. Например, в папку D:
\My Bots.
Укажите расположение (D:\My Bots) в поле Выберите путь к репозиторию в шаге 3.

5. Введите расположение, где вы хотите сохранить созданный отчет, в поле Выберите папку
назначения.

Note:  Связанные файлы и папки Bot Scanner в папке назначения перезаписываются, если вы
указали то же расположение при предыдущем использовании Bot Scanner.

6. Введите значение в поле Время ожидания, чтобы указать максимальное время, за которое Bot
Scanner проанализирует бот.
Если сканирование бот занимает больше, чем значение, указанное в поле Время ожидания,
Bot Scanner прекращает сканирование бот и переходит к сканированию других боты в
репозитории.

7. In the Generate output report for option, select the options for which you need to generate the
report.

Note:  For repositories that are more than 10 GB in size, we recommend that you select only the
Bots option for generating the report.

8. Щелкните Создать отчет.
Bot Scanner начинает анализировать боты в репозитории.
Bot Scanner выдает ошибку, если сканирует бот, который создан с использованием
неподдерживаемой версии Enterprise Client. Вы должны обновить бот до поддерживаемой
версии Enterprise Client и отсканировать бот снова.

9. Optional: Можно щелкнуть Остановить сканирование, когда Bot Scanner анализирует боты,
чтобы отменить операцию.
Для боты, которые были проанализированы до отмены операции, доступны сводный отчет и
отдельные отчеты.

10. Щелкните Открыть отчет, чтобы открыть сводный отчет в браузере по умолчанию после того,
как Bot Scanner завершит анализ всех боты в репозитории.

See the following video on how to use the scanner to scan Enterprise 11 or 10 боты:

• For migration: Анализ отчета Bot Scanner для миграции on page 1171
• For IE EOL: Analyze report for Internet Explorer боты on page 788
• For Basic authentication EOL: Scan Automation 360 боты for Эл. почта action with Basic authentication

usage on page 808
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Related concepts
Обзор Bot Scanner on page 1166
Bot Scanner анализирует боты (TaskBots и MetaBots), созданные в Control Room Enterprise 10 или
Enterprise 11. The scanner generates a report summarizing the number of боты, commands, and variables
that are ready for migration and those not yet supported for migration, and provides a recommendation on
whether you are ready for migration.
Related reference
Анализ отчета Bot Scanner для миграции on page 1171
You can analyze the report generated by the Bot Scanner to get information about the боты (TaskBots and
MetaBots) and processes that can be migrated. Воспользуйтесь Bot Scanner, чтобы решить, готовы ли
вы начать миграцию сейчас или хотите подождать, пока не будет обеспечена поддержка большего
числа команд.

Анализ отчета Bot Scanner для миграции
You can analyze the report generated by the Bot Scanner to get information about the боты (TaskBots and
MetaBots) and processes that can be migrated. Воспользуйтесь Bot Scanner, чтобы решить, готовы ли
вы начать миграцию сейчас или хотите подождать, пока не будет обеспечена поддержка большего
числа команд.
The Bot Scanner report provides the following information:
• Боты: In the Bot Scanner report, a бот is an individual TaskBot (.atmx) or MetaBot (.mbot) that is used

in other боты.
The Bots tab provides detailed information about боты that can be migrated, those that require action
or review, and those that cannot be migrated.

• Processes: In the Bot Scanner report, a process is a бот that is not used in any other боты and can
include one or more child боты.
The Processes tab provides detailed information about processes that can be migrated, those that
require action or review, and those that cannot be migrated.

The Bot Scanner provides the following important information about the боты and processes:
• Number of боты and processes analyzed
• A high-level summary in the form of boards to indicate the migration status of боты and processes
• Number of боты and processes that you can and cannot migrate to Automation 360
• Commands that are used in the боты and the frequency of usage
• Reasons why боты and processes cannot be currently migrated and frequency of such occurrences
• Actions and reviews required by the users after migration due to change in the behavior of the

commands
• Боты and processes that cannot be migrated and their corresponding error messages
• Number of lines in боты, and total number of lines of each боты associated with a process
• Line number for individual боты and processes that need review or action

Important:  Automation 360 часто обновляется для достижения 100%-ной функциональной
эквивалентности с версиями Enterprise 10 или Enterprise 11. The percentage of боты, commands, and
variables that are supported for migration in Automation 360 will increase until it reaches 100% over the
next upcoming releases. То есть, для каждой функции, которую вы используете в Enterprise 10 или
Enterprise 11, в Automation 360 можно найти эквивалентную возможность.
Большинство функций Enterprise 10 или Enterprise 11 доступны в исходном виде, однако некоторые
функции реализованы другим образом для поддержки веб-операций (без клиента). Для этих
функций необходимо изменить способ, с помощью которого написаны боты.
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Bot Scanner предназначен для сканирования боты (TaskBots и MetaBots), созданных с
использованием Enterprise Client Enterprise 10 и Enterprise 11. Общее число файлов включает в себя
файлы, которые были пропущены и не просканированы.
Отчеты доступны в расположении вывода, которое вы указали в поле Выбрать целевую папку в
диалоговом окне Automation Anywhere Bot Scanner. The Bot Scanner generates a summary report
(summary.html) and a separate XML for each бот that it scanned. Отдельный отчет создается для
каждой логики, доступной в MetaBot.
Для каждого просканированного бот создается папка raw-data, которая содержит
соответствующие отчеты (в формате XML). Это помогает нашим инженерам анализировать процесс
миграции и при необходимости его корректировать. Никакая информация, позволяющая установить
личность (PII), не включается в сводный отчет или отдельные отчеты об отсканированных боты.
Если вы решите поделиться с нами отчетами, чтобы помочь улучшить продукт, выполните сжатие
файлов в папке raw-data и согласуйте это со своим менеджером-консультантом (CSM) или
менеджером по работе с партнерами (PEM). Никакие данные не передаются в Automation Anywhere
автоматически.

Сводный отчет по всем боты

The Bot Scanner utility provides an option to scan for either боты or processes, or боты and processes.
Depending on what you choose, the summary report will contain information about the боты, processes,
or боты and processes. Most of the sections seen in these summary reports will be the same except that
in the боты and processes summary report you will also see an additional All tab that lists all the боты or
processes that are flagged and sorted as Action required, Review required, No review required, and
Non Migratable.

Note:  For generating processes summary report, the maximum repository size that is supported is up to
10 GB.

The summary report provides information about the following:
• whether you can migrate to Automation 360
• the total number of боты scanned
• боты only report that provides information about the боты supported for migration to Automation 360

(in percentage)
• processes only report that provides information about the processes supported for migration to

Automation 360
• боты and processes combined report that provides information about the боты and processes

supported for migration to Automation 360

Например, Bot Scanner просканировал 10 боты. Если 8 боты (из 10 боты) готовы к миграции в
Automation 360, то процентное значение боты, которые могут быть перенесены, составляет 80%, а
процентное значение боты, которые сейчас невозможно перенести, составляет 20%.
Reviewing the Bot Scanner report for боты
Рассмотрим сценарий, в котором в общей сложности просканировано 1618 боты, 98% из которых
(1614 боты) могут быть перенесены в Automation 360. Однако 5% боты требуют принятия мер после
миграции, а 2% (4 боты) в настоящее время невозможно перенести по определенным причинам. В
таком сценарии отчет Bot Scanner позволяет выполнить следующие действия.
• Identity the actions and reviews for the remaining 5% of боты so that you can successfully migrate a

majority of your боты and run them in Automation 360 after migration.
• Определите, какие боты можно перенести в Automation 360 без какого-либо вмешательства

вручную.
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• Определите причину, по которой 2% боты в настоящее время нельзя перенести, и
предполагаемое время, когда вы сможете перенести их позже. Эта причина может быть связана с
командами и переменными, которые еще не поддерживаются в Automation 360.

Reviewing the Bot Scanner report for processes
To review a process message, perform these steps:
1. Click the Processes tab.
2. Click the messages tab that you want to review.
3.

In the Master Task Reference column, click the expand icon ( ) to view the process.
4. Click a process name to view the message.

Consider a scenario where you have a total of 100 processes, of which 99 processes can be migrated to
Automation 360. However, 5 processes require action after migration, 10 processes require review after
migration, and 1 processes cannot be currently migrated due to certain reasons. В таком сценарии отчет
Bot Scanner позволяет выполнить следующие действия.
• Identity the actions and reviews for the remaining 15 processes so that you can successfully migrate a

majority of your processes and use them in Automation 360 after migration.
• Identify processes that can be migrated to Automation 360 without any manual intervention.
• Identify the reason why that 1 process cannot be currently migrated and the estimated time for when

you can migrate them later.
Эта причина может быть связана с командами и переменными, которые еще не поддерживаются
в Automation 360.

На следующем изображении представлен пример отчета из Bot Scanner.
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В следующей таблице представлены различные поля в примере отчета Bot Scanner (в соответствии с
нумерацией на предыдущем изображении).

Поле/параметр Описание

1 Provides a summary and status of the migration readiness of your боты. Review
the status of migrated based on the following:
• Green: You can proceed with migration provided that you review the report for

any action or review required for your боты.
• Amber: You have to wait for migrating your боты as the percentage of боты

that are qualified for migration do not meet the migration requirements.

2 Provides a summary of the following information for боты:
• Migratable Bots: Provides a summary of the total number of боты that can

be migrated.
• Total Bots: Provides a summary of the total number of боты that were

scanned.
• Action Required: Provides a summary of the total number of боты that

require action after migration to Automation 360.
• Review Required: Provides a summary of the total number of боты that

require review after migration to Automation 360.
• No Review Required: Provides a summary of the total number of боты that

can be migrated to Automation 360 without any manual intervention.
• Non Migratable: Provides a summary of the total number of боты that

cannot be currently migrated to Automation 360.

3 Provides additional resources to ease the migration process.

4 Provides a summary of the following information for processes:
• Migratable Processes: Provides a summary of the total number of processes

that can be migrated.
• Total Processes: Provides a summary of the total number of processes that

were scanned.
• Action Required: Provides a summary of the total number of processes

that require action after migration to Automation 360. Even if a child бот in a
process requires action, the process is flagged as Action Required.

Note:  If a process contains боты where some of them require review and
some others require action, then the process is flagged as Action Required.
The Action Required status takes precedence over the Review Required
status.

• Review Required: Provides a summary of the total number of processes
that require review after migration to Automation 360. Even if a child бот in a
process requires review, the process is flagged as Review Required.

• No Review Required: Provides a summary of the total number of processes
that can be migrated to Automation 360 without any manual intervention. All
the боты in the process can be migrated.

• Non Migratable: Provides a summary of the total number of processes that
cannot be currently migrated to Automation 360. All the боты in the process
cannot migrated.
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Поле/параметр Описание

5 • Bots > All > Bots or Processes > All > Bots: Go to this view for a list of
all the боты or processes that are flagged and sorted as Action required,
Review required, No review required, and Non Migratable.

• To view the message for a specific бот that require action or review, click the
бот name.

• To view the message for a specific process that require action or review, click

the expand icon ( ), and then click the task reference name.

Click the message code to view the information about changes in Automation
360 behavior for the command compared with the Enterprise 11 or Enterprise 10
behavior.

Note:  Каждое сообщение содержит информацию, которую требуется
просмотреть после миграции. Список этих сообщений см. в разделе
Сообщения для ознакомления on page 1332. Use the message code (for
example R102) to view the specific message quickly.

6 Bots > Action required > Bots or Processes > Action required > Bots: Go
to this view for the list of боты or processes that require action after migration to
Automation 360.
• To view the message for a specific бот that require action, click the бот name.
• To view the message for a specific process that require action, click the expand

icon ( ), and then click the task reference name.

Click the message code to view the information about changes in Automation
360 behavior for the command compared with the Enterprise 11 or Enterprise 10
behavior.

Note:  Каждое сообщение содержит информацию, которую требуется
просмотреть после миграции. Список этих сообщений см. в разделе
Сообщения для ознакомления on page 1332. Use the message code (for
example R102) to view the specific message quickly.
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Поле/параметр Описание

7 • Bots > Review required > Bots or Processes > Review required >
Bots: Go this view for a list of the боты or processes that require review after
migration to Automation 360.

• Чтобы просмотреть сообщение о необходимости выполнения проверки для
определенного бот, щелкните по имени бот.

• To view the review required message for a specific process, click the expand

icon ( ), and then click the task reference name.

Click the message code to view the information about changes in Automation
360 behavior for the command compared with the Enterprise 11 or Enterprise 10
behavior.

Note:  Каждое сообщение содержит информацию, которую требуется
просмотреть после миграции. Список этих сообщений см. в разделе
Сообщения для ознакомления on page 1332. Use the message code (for
example R102) to view the specific message quickly.

8 Bots > No review required > Bots or Processes > No review required
> Bots: Go to this view for a list of боты or processes that can be migrated to
Automation 360 without any manual intervention.

9 Bots > Non Migratable > Bots or Processes > Non Migratable > Bots: Go
to this view for a list of боты or processes that cannot be currently migrated to
Automation 360.

10 Bots > Commands : Go to this view for a list of the commands that can be
migrated and the number of times the commands are used across all your
scanned боты.

11 • Имя Бот. In the Bots tab, click a бот name to view the action required
message of a specific бот, click the бот name.

• Master Task Reference: In the Processes tab, to view the action required

message of a specific process, click the expand icon ( ), and then click a
task reference name.

Click the message code to view the manual steps you must perform to run the
migrated process successfully in Automation 360.
Кроме того, вы можете просмотреть команды, которые содержит бот, а также
частоту или количество раз, когда команда используется в бот.

Note:  Каждое сообщение содержит причину и действие, которое необходимо
выполнить после миграции. Список этих сообщений см. в разделе Сообщения
о необходимости выполнить действия on page 1318. Use the message code (for
example A101) to view a specific message quickly.

12 Provides the location of the бот.

13 Provides the status of the бот or process.
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Поле/параметр Описание

14 • For боты, this field displays the number of lines used in a бот. This information
will help you understand the complexity of the бот.

• For processes, this field displays the sum of the total number of lines used
in the parent and child боты within a process. This information will help you
understand the complexity of the process.

15 For processes, this field displays the number of боты in a process that requires

action after migration to Automation 360.. Click the expand icon ( ) and then
click a task reference name that is flagged as Action Required.
Click the message code to view the information about changes in Automation
360 behavior for the command compared with the Enterprise 11 or Enterprise 10
behavior.

Note:  This field is available only for processes.

16 For processes, this field displays the number of боты in a process that requires

review after migration to Automation 360. Click the expand icon ( ) and then
click a task reference name that is flagged as Review Required.
Click the message code to view the information about changes in Automation
360 behavior for the command compared with the Enterprise 11 or Enterprise 10
behavior.

Note:  This field is available only for processes.

17 Download (as a CSV file) the list of боты, processes, or commands that can or
cannot be migrated so that you can share the file with others.

18 • For боты, this field displays the number of times a бот is used as a child бот.
• For processes, this field displays the sum of the total number of dependencies

used in the parent and child боты within a process.

Отчет действителен до тех пор, пока не будет доступна следующая версия Bot Scanner. Когда
следующая версия Bot Scanner будет доступна, отобразится сообщение об истечении срока действия
отчета. Вам потребуется загрузить последнюю версию Bot Scanner и просканировать боты снова.

Проверки и действия, которые необходимо выполнить после миграции

Некоторые команды в боты могут быть отмечены как требующие проверки в отчете Bot Scanner.
Для этих элементов необходимо выполнить определенную проверку или обновить боты после их
переноса.
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Следующие сообщения Bot Scanner требуют выполнения проверки или определенных действий.
• Путь к дочернему боту полностью состоит из переменных и определяется во

время выполнения.Если путь, определенный с помощью переменных, является
недействительным, произойдет сбой бота.Проверьте бот для переноса.

Убедитесь, что дочерний бот доступен в расположении, указанном в пути с переменными. Если
путь в родительском бот определен неверно, обновите путь, чтобы он указывал на правильный
дочерний бот.

• Значение, возвращаемое системной переменной «Описание ошибки», может
отличаться в устаревших версиях.Проверьте перенесенный бот.

Описание некоторых сообщений об ошибках в Automation 360 может отличаться от Enterprise
11 или Enterprise 10. Если бот Enterprise 11 или Enterprise 10 настроен на принятие решений
на основе описания сообщений об ошибках, вам, возможно, придется обновить перенесенные
данные бот на основе нового описания сообщений об ошибках.

• Перенос команды «База данных - Подключение» завершен, но требуется также
настроить «Аутентификация Windows».Для получения дополнительных сведений см.
документацию пакета базы данных.

Выполните указанные шаги для подключения к Microsoft SQL Server с помощью аутентификации
Windows. См. раздел Подключение к Microsoft SQL Server с использованием аутентификации
Windows on page 1470.

• Миграция «ЕСЛИ» с переменным условием завершена.Однако не удалось определить
формат даты пользовательской переменной, поэтому миграция выполнена с
использованием формата даты по умолчанию: mm/dd/yyyy HH:mm:ss.Проверьте и
при необходимости измените формат.

Обновите формат даты в перенесенном бот в соответствии с тем форматом, который
используется в Enterprise 11 для этого бот.

• Не удалось определить, является ли переменная, используемая в качестве
позиции, индексом или именем столбца.Позиция индекса начинается с 0, а не с
1, поэтому при необходимости выполните соответствующие действия.

Если вы использовали системную переменную FileData Column[$variable$] или Excel
Column[$variable$] в бот Enterprise 11 или Enterprise 10, предполагается, что вы использовали
имя столбца в переменной $variable$. В таких случаях перенесенный бот содержит выражение
FileData Column{$variable$}. Если переменная $variable$ в бот Enterprise 11 или Enterprise
10 содержит номер столбца, вы должны изменить выражение в перенесенном бот на
FileDataColumn[$var.String:toNumber()$].
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• Команда «Запустить логику», которая использует переменные учетных данных в
качестве входных данных для логики MetaBot

Боты, использующие команду Запустить логику, которая передает атрибуты Credential Vault из
TaskBot в логику MetaBot, могут быть перенесены в Automation 360. Имя учетных данных и имя
атрибута отображаются в полях в соответствующей строке перенесенного бот.
Если вы выполнили миграцию с использованием восстановленной базы данных Enterprise
11, эквивалент ячейка будет создан в Automation 360 для переменных учетных данных,
используемых в бот Enterprise 11.
Выберите один из следующих вариантов, чтобы успешно запустить перенесенные боты.
• Вариант 1. Передайте переменные типа «Компонент учетных данных».

1. Создайте переменную типа «Компонент учетных данных» в дочерних боты в качестве
входной переменной.

2. В action Запустить в пакет TaskBot родительского бот обновите поля входных значений,
чтобы использовать атрибуты Credential Vault для переменной типа учетных данных,
созданной для дочернего бот (в соответствии с логикой MetaBot).

• Вариант 2. Передайте значения учетных данных в качестве глобального значения.
1. Создайте глобальное значение в Automation 360 для учетных данных, используемых в

команде Запустить логику в Enterprise 11.
2. В action Запустить в пакет TaskBot родительского бот обновите поля входных значений,

чтобы использовать глобальные значения для переменной типа учетных данных,
созданной для дочернего бот (в соответствии с логикой MetaBot).

Если вы не использовали восстановленную базу данных Enterprise 11 при установке Automation
360, перед выполнением шагов, представленных выше, вам потребуется создать необходимую
ячейку для переменных учетных данных, используемых в бот Enterprise 11.

Note:  Automation 360 обеспечивает повышенный уровень безопасности, позволяя присваивать
атрибуты Credential Vault только переменным типа учетных данных. Это ограничивает любую
небезопасную работу с атрибутами Credential Vault, если они присвоены переменным типа не
учетных данных.

Отчет для отдельного бот

Отчет для отдельного бот содержит информацию о зависимостях, переменных и использованных
командах.
Отчет для отдельного бот выглядит примерно так, как показано в следующем коде:

            <analysis version="1.3.0">
                <stat>
                    <dependencies ucount="0" count="0"/>
                    <errors ucount="6" count="12">
                        <error count="1">System variable $AAApplicationPath
$</error>
                        <error count="1">Command [If FolderNotExist] 
                        is not supported</error>
                        <error count="3">System variable $CurrentDirectory
$</error>
                        <error count="3">System variable $Extension$</error>
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                    </errors>
                </stat>
                <commands>
                    <command target-action="assign" name="VariableOperation"
 line="1" 
                    grp="VariableOperation" api="VarOpe">
                        <msg type="error" review="true"
 category="variable">System 
                        variable $AAApplicationPath$</msg>
                        <msg type="info" review="false"
 category="default">Command 
                        parameter [Option] of type [String] is not
 required.</msg>
                    </command>
                    <command target-action="createFolder"
 name="createFolder" line="3" 
                    grp="FilesFolders" api="CreateFolder"/>
                    <command target-action="copyFiles" name="CopyFiles"
 line="5" 
                    grp="FilesFolders" api="CreateFolder"/>
                    <command target-action="connect" name="Connect"
 line="3" 
                    grp="Database" api="Connect"/>
                    <command target-action="OpenCSVTXT" name="ReadFrom"
 line="9" 
                    grp="CsvText" api="Csv"
                        <msg tpye="info" review="false"
 category="command">Line 
                        in 11.x client, there is no separate option given
 for CSV 
                        and TEXT in Automation 360</msg>
                            <msg type="error" review="true"
 category="variable">System 
                            variable $CurrentDirectory$</msg>
                            <msg type="error" review="true"
 category="variable">System 
                            variable $Extension$</msg>
                            <msg type="error" review="true"
 category="variable">System 
                            variable $FileName$</msg>
                        </command>
                    </commands>
                    <variables>
                        <variable name="$CSV-TXT-Default-DATA$" 
                        type="TABLE" value-type=""/>
                    </varaibles>
                </analysis>
            

В следующей таблице представлены различные атрибуты, доступные в отчете в формате XML,
показанном на предыдущем изображении.

Узел Атрибут Описание

Статистика-- Предоставляет информацию о числе зависимостей, ошибок и
предупреждений.

-- зависимости Указывает число зависимостей для бот. The ucount indicates the
number of unique dependencies and the count indicates the total number
of dependencies.

-- ошибка Указывает число ошибок для бот. The ucount indicates the number of
unique errors and the count indicates the total number of errors.
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Узел Атрибут Описание

Команда -- Предоставляет информацию о различных командах и действиях,
используемых в бот.

-- целевое
действие
команды

Указывает действие, выполняемое для команды.

-- имя Указывает имя команды.

-- строка Указывает номер строки, в которой команда доступна в бот.

-- группа Указывает группу команд, к которой принадлежит команда.

-- api Указывает имя API, который использует команда.

-- тип
сообщения

Предоставляет информацию о типе сообщения. The error type
indicates that the command cannot be migrated to Automation 360, and
an info type indicates that the command can be migrated but some of its
attributes will be changed during migration.

-- Рассмотреть Предоставляет информацию о том, нужно ли проверять команду.
This attribute is always true for error type messages, which indicates
that migration of that command to Automation 360 is not yet supported.
For info type messages, if the attribute is true, you must review the
value in the category attribute. You can decide whether you want to
take any action on the migrated бот based on the value available in the
category attribute.

-- категория Предоставляет информацию о команде или переменной, для которой
отображается сообщение.

Переменные Предоставляет информацию о системных переменных, используемых
бот.

-- имя
переменной

Указывает имя переменной.

-- тип Указывает тип переменной.

-- тип
значения

Указывает тип значения, предоставляемого для этой переменной.

See the following video on how to analyze the scanner report

Получить лицензию на миграцию
Миграция доступна бесплатно. Для миграции в среду Automation 360 (Cloud или On-Premises)
необходимо запросить лицензию на миграцию.

Условия и срок действия лицензии

• Если для завершения миграции требуется больше времени, чем ожидалось, обратитесь к
менеджеру-консультанту или представителем по работе с клиентами, чтобы обсудить сроки.
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• Ваша лицензия на миграцию Automation 360 является переходной. Это означает, что она будет
пересекаться с лицензией Enterprise 10 или Enterprise 11 в течение периода миграции.
После завершения миграции продукты и лицензии Automation 360 будут перенесены в рамках
вашего текущего контракта в формате «1-к-1». Вам следует рассмотреть свои требования к
автоматизации или проверить даты возобновления и определить, необходимы ли обновления
лицензирования.

Note:  Запустите Bot Scanner и определите дату первой миграции. Мы рекомендуем запрашивать
лицензию на миграцию только после запуска Bot Scanner и изучения предварительных условий
выбранного варианта развертывания.

Запрос лицензии на миграцию

Когда вы будете готовы начать миграцию, свяжитесь с представителем по работе с клиентами,
отправьте свой отчет Bot Scanner и укажите, какие лицензии вы запрашиваете: для развертывания
Automation 360 Cloud или On-Premises.
• Для начала работы с Automation 360 (Cloud или On-Premises) потребуется принять условия

использования.
• Поскольку в Automation Anywhere будут размещаться пользовательские данные, клиенты,

переходящие на Automation 360 Cloud должны также принять условия соглашения Automation
Cloud.

Для миграции Cloud следует учитывать следующее.
• You must request the equivalent number of licenses for Control Room and other entitlements such as

Bot Creator, Bot Runner, IQ Bot, and Bot Insight.
Происходит сбой миграции, если количество лицензий Automation 360 не равно количеству
Control Room и других прав, доступных в вашей среде Enterprise 11
Ensure that the number of Automation 360 licenses is equal to the number of Control Room and other
entitlements available in your environment.
В противном случае после миграции для неперенесенных учетных записей пользователей
потребуются дальнейшие действия.

• Вы должны запросить лицензию, когда будете готовы начать миграцию, поскольку код миграции
действителен в течение 30 дней.
Если вы не готовы начать миграцию, но получили лицензию на миграцию (вместе с кодом
миграции), 30-дневный срок действия кода может истечь к моменту начала миграции, либо у вас
может не хватить времени для завершения миграции.

Активация лицензии

• Automation 360 Cloud. Вам будет предоставлен код миграции, включающий лицензию на
миграцию. Вставьте этот код в утилиту миграции Cloud, а затем запустите ее для активации
лицензии.

• Automation 360 On-Premises. После завершения установки Automation 360 загрузите GUID при
открытии файла Automation 360 Control Room. Если у вас нет GUID лицензии, загрузите текущий
файл лицензии.
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Подготовка новой Control Room для миграции
Выполните задачи этого потока операций, чтобы подготовить среду Automation 360 к миграции.
При проверки готовности к миграции убедитесь, что вы выполнили все необходимые задачи.
Проверьте готовность к миграции on page 1142.

1. Choose a deployment model (Cloud, Cloud-enabled, or On-Premises).
2. Запросите и активируйте лицензию на миграцию.
3. В зависимости от выбранной модели развертывания подготовьте среду к миграции:

Модель развертывания Действия

Cloud • Выполните миграцию с помощью Утилиты
миграции в облако: Подготовка к миграции
с Enterprise 11 в Automation 360 Cloud on page
1186

• Use both Automation 360 Cloud and
Enterprise 11 in parallel: Подготовка к
миграции при параллельном использовании
Enterprise 11 и Automation 360 Cloud on page
1195

• Ручная миграция в Cloud: Подготовка к
ручной миграции в Cloud Automation 360 on
page 1196

С поддержкой облака Подготовка миграции с Enterprise 11 на
Automation 360 с поддержкой облака on page
1211

On-Premises • Enterprise 11 в Automation 360:
• Подготовка к миграции с Enterprise 11 в

Automation 360 On-Premises on page 1198
• Use both Automation 360 On-Premises

and Enterprise 11 in parallel: Подготовка
к миграции при параллельном
использовании Enterprise 11 и Automation
360 On-Premises on page 1208

• Enterprise 10 в Automation 360:
• Подготовка к миграции с Enterprise 10 в

Automation 360 On-Premises on page 1213
• Используйте Automation 360 On-Premises

и Enterprise 10 параллельно: Подготовка
к миграции при параллельном
использовании Enterprise 10 и Automation
360 On-Premises on page 1219
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4. Выполните задачи перед миграцией.

Миграция и проверка боты on page 1222

Выберите модель развертывания
Платформа Automation 360 разработана на базе облачной архитектуры с единой базой кода,
которая поддерживает развертывания Cloud и On-Premises. Всех компоненты обрабатываются
одинаково вне зависимости от того, развернута платформа в Cloud или в вашей собственной
инфраструктуре (On-Premises), которая может представлять собой физические серверы, частное
Cloud или общедоступное Cloud.

Note:  Миграция доступна в Automation 360 начиная со сборки 2079 для развертываний On-Premises
и сборки 7554 для развертываний Cloud.

Модели развертывания
Automation 360 предоставляет следующие модели развертывания.

Cloud Automation 360 Cloud размещается в Automation
Anywhere, что дает возможность использовать
простую модель потребления платформы
Automation 360, созданную на базе облачной
архитектуры. С помощью службы Automation
360 Cloud платформа Automation 360, которая
включает Control Room и приложения Automation
360(Рабочая область RPA, IQ Bot, Bot Insight,
AARI и Discovery Bot), размещается в Automation
Anywhere. Доступ к ней пользователи могут
получить с помощью веб-браузера. Устройства
Bot Agent, где боты запускают и выполняют
автоматизацию, остаются в инфраструктуре
клиента и безопасно подключаются к службе
Automation 360 Cloud через протокол HTTPS.

С поддержкой облака В этой модели развертывания данные
размещаются On-Premises. Эта модель подходит
для клиентов, нуждающихся в соблюдении
строгих нормативных требований, которые
предполагают обязательный суверенитет
данных.

On-Premises with packages updates through
Cloud

With Automation Anywhere On-Premises with
packages updates through Cloud service, all
business, personal, and operational data is kept on
and deployed from the server on-premises on the
customer network.

На следующем изображении показаны модель развертывания для Automation 360:
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См. также Условия эксплуатации Cloud on page 27.

Important:
• Независимо от выбранной модели развертывания рекомендуется установить первый экземпляр

Automation 360 в качестве среды разработки.
• Рекомендуется иметь три отдельных среды для Bot Lifecycle Management: разработка,

тестирование и производство.
• Создание среды разработки во время миграции предоставляет следующие два преимущества.

• Платформа для тестирования перенесенных боты Enterprise 11 или Enterprise 10 позволяет
убедиться, что боты успешно запущены и обеспечивают ожидаемые результаты.

• Доступ разработчиков к новой среде Automation 360 для одновременного создания новой
автоматизации во время тестирования перенесенных боты.
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Подготовка к Cloud

При выборе развертывания Cloud Automation Anywhere не нужно создавать дополнительную
инфраструктуру физических серверов для настройки Control Room. После завершения обновления
будут автоматически установлены по всей организации, и их можно легко масштабировать в Cloud.
Перед началом работы с Automation 360 в Cloud Automation Anywhere убедитесь в соблюдении
системных требований и требований совместимости для запуска Automation 360.
• Требования совместимости к Bot Agent. Bot Agent должен быть установлен на зарегистрированных

устройствах, чтобы пользователи могли создавать и запускать на них боты.

Подготовка к развертыванию Automation 360 с поддержкой облака

При выборе развертывания с поддержкой облака требуются два экземпляра Control Room: один
разворачивается в Cloud Automation Anywhere , а другой — в вашей инфраструктуре. The Control
Room deployed on Cloud manages the operational services and the Control Room installed on your
infrastructure manages your business and operational data.
• Требования совместимости к Bot Agent. Bot Agent должен быть установлен на зарегистрированных

устройствах, чтобы пользователи могли создавать и запускать на них боты.
• Системные требования: требования к аппаратному обеспечению и центрам обработки данных,

включая серверы, базы данных, порты, протоколы и другое.

Подготовка к On-Premises (инфраструктура клиента)

Установите и сохраните Automation 360 в собственной инфраструктуре. After you have completed your
upgrade, you will benefit from regular updates for packages with new release builds made available to
download and install. Убедитесь, что On-Premises Automation 360 отвечает системным требованиям и
требованиям настройки.
• Требования совместимости к Bot Agent. Bot Agent должен быть установлен на зарегистрированных

устройствах, чтобы пользователи могли создавать и запускать на них боты.
• Системные требования: требования к аппаратному обеспечению и центрам обработки данных,

включая серверы, базы данных, порты, протоколы и другое.

Подготовка к миграции с Enterprise 11 в Automation 360 Cloud
Выполните задачи этого потока операций для миграции с Enterprise 11 в Automation 360 Cloud,
включая миграцию ваших боты.
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Workflow map: You can also view this migration workflow in an interactive visual format by clicking the

following schematic image:
1. Migrating from Enterprise 11 to Automation 360 Cloud

1. Проверьте, что вы выполнили следующие задачи для проверки готовности к миграции

Проверьте готовность к миграции on page 1142
2. Проверьте, что вы приобрели и активировали лицензию на миграцию.

Получить лицензию на миграцию on page 1181

Информацию об управлении лицензиями и Cloud службами и их обработке см. в разделе Управление
лицензиями и их и распределение (партнеры).

Important:
• We support migration only to an Automation 360 Control Room that is hosted on Amazon Web Services

(AWS).
• Миграция выполняется в новое Cloud Control Room, которое будет создано во время миграции. Вы

не можете повторно использовать существующее Cloud Control Room для миграции.
• Данные журналов и информационной панели Bot Insight исключены из загрузки в Cloud Control

Room.
• Поддерживается миграция данных со стандартных развертываний баз данных Microsoft SQL. См.

раздел Поддерживаемые для миграции версии Control Room on page 1143.
• Если решение Enterprise 11 настроено на использование Active Directory или единого входа (SSO),

тип аутентификации для всех перенесенных пользователей в Automation 360 Cloud будет изменен
на базу данных. Для всех перенесенных пользователей, кроме главного администратора, пароль
имеет значение null.
Главный администратор получает учетные данные для входа по электронной почте. Перед
миграцией боты главный администратор может изменить тип аутентификации для пользователей
на SSO.

• Рекомендации: Создайте резервную копию данных, которые не переносятся в Automation 360
Cloud (журналы аудита и системные журналы), перед выводом из эксплуатации экземпляров
Enterprise 11.

Для миграции IQ Bot см. Migrate from Automation 360 IQ Bot On-Premises to Cloud on page 1360.
1. Проверьте, что все переменные учетных данных, используемые в боты Enterprise 11, доступны в

Enterprise 11 Control Room.
2. Загрузите и установите Утилиту миграции Cloud.

Установка утилиты миграции Cloud on page 1190
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3. Используйте Утилиту для загрузки данных Enterprise 11 в Automation Anywhere Cloud.
Загрузка данных Enterprise 11 с помощью Утилиты миграции Cloud on page 1193

Предварительные задачи для миграции боты on page 1222

Рекомендуемый поток операций для миграции Cloud
Проанализируйте процесс переноса данных Enterprise 11 в Cloud Automation 360, особенно если вы
используете отдельные среды для разработки, тестирования и производства.

Important:  Это рекомендуемый поток операций для миграции с Enterprise 11 в Cloud Automation
360.

В некоторых сценариях, в зависимости от требований, могут существовать отдельные среды
Enterprise 11 для разработки (Dev), приемочного пользовательского тестирования (UAT) и
производства (Prod), и каждая из этих сред может иметь несколько экземпляров Control Room. Число
запрашиваемых вами лицензий Cloud Control Room должно быть равно общему числу экземпляров
Control Room во всех ваших средах Enterprise 11. Например, если у вас есть отдельные среды для
разработки, приемочного пользовательского тестирования (UAT) и производства, и каждая из этих
сред имеет два экземпляра Control Room, вы должны запросить шесть лицензий Cloud Control Room.
Если вы выполняете миграцию с Enterprise 11 в Cloud Automation 360, вам потребуется скопировать
всех боты из производственной и тестовой сред в среду разработки, используя Bot Lifecycle
Management. Это гарантирует, что все новые или измененные боты, доступные в производственной
и тестовой средах, станут доступны в среде разработки до начала процесса миграции.
На следующем изображении показан поток операций миграции из Enterprise 11 в Cloud Automation
360.
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1. Необязательно. Скопируйте боты из производственной среды Enterprise 11 в среду разработки
с помощью Bot Lifecycle Management.
Bot Lifecycle Management - an overview

2. Необязательно. Скопируйте боты из среды приемочного пользовательского тестирования
(UAT) Enterprise 11 в среду разработки с помощью Bot Lifecycle Management.
Bot Lifecycle Management - an overview

3. Проанализируйте и определите команды и переменные, используемые в боты, которые
поддерживаются для миграции на Automation 360.
Scan Enterprise 11 or 10 боты using Bot Scanner on page 1168 | Анализ отчета Bot Scanner для
миграции on page 1171
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4. Загрузите данные Enterprise 11 в Cloud Control Room среды разработки с помощью утилиты
миграции Cloud.

Установка утилиты миграции Cloud on page 1190 | Загрузка данных Enterprise 11 с помощью
Утилиты миграции Cloud on page 1193

5. Загрузите данные Enterprise 11 в Cloud Control Room среды приемочного пользовательского
тестирования (UAT) с помощью утилиты миграции Cloud.

6. Загрузите данные Enterprise 11 в Cloud Control Room производственной среды с помощью
утилиты миграции Cloud.

7. Выполните следующие шаги в Cloud Automation 360 в среде разработки.
a. Преобразуйте боты (TaskBots и MetaBots) в формате .atmx и .mbot в формат Automation

360 .bot с помощью Bot Migration Wizard.
b. Скопируйте преобразованные боты в Cloud Automation 360 в среде приемочного

пользовательского тестирования (UAT) с помощью Bot Lifecycle Management.
Bot Lifecycle Management on page 2848

c. Протестируйте преобразованные боты в Cloud Automation 360 в среде приемочного
пользовательского тестирования (UAT).
Если какие-либо из перенесенных боты работают не так, как ожидалось, и требуют
внесения изменений, переместите эти боты в Cloud Automation 360 в среде разработки.
После внесения изменений переместите боты в Cloud Automation 360 в среде приемочного
пользовательского тестирования (UAT). Повторяйте этот процесс до тех пор, пока все
перенесенные боты не будут работать так, как ожидалось.

d. После того как все преобразованные боты будут протестированы и будут работать так, как
ожидалось, скопируйте этих боты в Cloud Automation 360 в производственной среде.

Установка утилиты миграции Cloud
Утилита миграции Cloud позволяет загрузить все ваши данные Enterprise 11 в Cloud Automation
Anywhere. После успешной загрузки данных в Cloud создается Control Room Cloud, и все
загруженные данные становятся доступны для использования в этой Control Room.
Утилита переносит данные из репозитория Control Room (боты, их зависимости и Credential Vault)
и базы данных Control Room (пользователей, функции, расписания, очереди и настройки Control
Room).

Note:  Миграция данных Control Room Enterprise 11, таких как пользователи, функции и учетные
данные, в Cloud Automation 360 на Google Cloud Platform не поддерживается.

Обратите внимание на следующие рекомендации.
• Ensure that you install the Cloud Migration Utility on the same application server where the Enterprise

11 Control Room is installed. Для Enterprise 11 также убедитесь, что утилита установлена в той же
базе данных, где размещена база данных Bot Insight.
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• Если вы установили Enterprise 11 в режиме кластера, установите утилиту миграции на одном из
узлов кластера.

1. Загрузите последнюю версию утилиты миграции Cloud с сайта поддержки Automation Anywhere:
A-People Downloads page (Login required).
a) В разделе Automation Anywhere Automation 360 щелкните по ссылке Утилита миграции в

облако Automation Anywhere Enterprise.
b) Загрузите экспортированный файл .zip.

2. Распакуйте файл .zip и запустите файл AAE Cloud Migration Utility.exe от имени
администратора.

3. На экране Требование щелкните Установить.
На экране перечислены приложения, необходимые для установки утилиты на компьютер.
Утилита сама устанавливает необходимые приложения; отдельная установка не требуется.

4. На приветственном экране щелкните Далее.
5. На экране Лицензионное соглашение прочитайте и примите условия использования

лицензии, а затем щелкните Далее.
6. На экране Целевая папка выберите Изменить, если вы хотите изменить место установки

утилиты, и щелкните Далее.
7. На экране Готовность к установке программы щелкните Установить.

На экране Установка утилиты миграции в облако AAE отображается ход установки.
8. На экране Выполнено щелкните Готово.

Для Enterprise 11: Загрузка данных Enterprise 11 с помощью Утилиты миграции Cloud on page 1193

Предварительные условия для миграции Cloud
После установки Утилиты миграции Cloud вы должны выполнить определенные задачи перед
началом загрузки данных в Automation 360.
Выполните следующие требования перед запуском Утилиты миграции Cloud для загрузки данных в
Automation 360 Cloud.
• Утилита миграции в облако

• Установка Утилиты миграции в облако
• Можно выполнить миграцию только одной Control Room за раз. Поэтому при подключении

к Control Room проверьте, что путь установки, путь к репозиторию и сведения базы данных
принадлежат одной и той же Control Room перед запуском Утилиты миграции Cloud.

• Код миграции: Проверьте, что вы получили электронное письмо с кодом миграции. Для
получения кода обратитесь к своему торговому представителю.
Код миграции действителен только для одной Control Room. Если у вас несколько экземпляров
Control Room, вы получите соответствующее количество кодов миграции. Проверьте, что вы
используете правильный код миграции для миграции конкретной Control Room.

Important:  Код миграции, полученный вами по электронной почте, действителен в течение
30 дней с момента его создания и передачи вам. Поэтому начните миграцию до истечения срока
действия кода. В противном случае вам придется запрашивать новый код, что может занять
значительное время.
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• Клиент-арендатор облака Automation Anywhere:
• The tenant name does not support the underscore ( _ ) character. So an underscore is used in the

tenant name, the specified URL will not be created.

• порт, брандмауэр, подключение к Интернету
• Порт, который используется для подключения к Enterprise 11 Control Room, должен быть

открыт и доступен для утилиты.
• Брандмауэр должен быть настроен так, чтобы разрешить утилите подключаться к источникам

ниже для исходящего HTTPS-трафика через порт 443:
• https://aa-provsvc.globalservices.automationanywhere.digital/
• https://aws.amazon.com

• Обеспечьте стабильное интернет-соединение с достаточной пропускной способностью, чтобы
загрузить данные в течение 60 минут. Если время загрузки превышает 60 минут, Утилита
миграции Cloud завершит работу, и вам придется начать процесс загрузки заново.

• Enterprise 11 Control Room
• Мы рекомендуем вам запланировать некоторое время простоя для Enterprise 11 Control Room

или остановить все действия пользователей при использовании Утилиты миграции.
Время простоя необходимо для того, чтобы не пропустить данные, когда Утилита миграции
Cloud упаковывает данные Enterprise 11 для загрузки. Если простой невозможен, проверьте,
что никакие действия пользователей не выполняются в Enterprise 11 Control Room, когда
Утилита миграции Cloud загружает данные.

• Control Room. Проверьте, что размер репозитория Enterprise 11 менее 20 Гбайт, а размер
базы данных Enterprise 11 менее 9 Гбайт.
Если размер репозитория или базы данных превышает указанные значения, обратитесь в
службу поддержки Automation Anywhere за помощью.

• Проверьте, что у учетных данных, которые вы использовали для подключения к базе данных
Enterprise 11, есть разрешение «db_owner».

• Проверьте, что репозиторий и база данных Enterprise 11, указанные в Утилите миграции Cloud,
принадлежат одной и той же Enterprise 11 Control Room.

• Файлы журналов: Предоставьте Утилите миграции доступ к папке C:\ProgramData
\AutomationAnywhere для хранения файлов журнала.

• Credential Vault. Убедитесь, что режим Credential Vault — экспресс-режим.
• Этот режим гарантирует, что учетные данные и переменные, доступные в Enterprise 11

Credential Vault, будут перенесены в Cloud Control Room.
• Если для Credential Vault установлен ручной режим в Enterprise 11, учетные данные и

переменные в Enterprise 11 Credential Vault не будут перенесены в Cloud Control Room.

Вы можете изменить режим обратно на ручной после того, как будет выполнена миграция
данных Control Room. См. раздел Configure Credential Vault Connection mode on page 2756.

• SSO: Если вы хотите интегрировать SSO после миграции в Automation 360 Cloud, проверьте,
что идентификаторы пользователей в Enterprise 11 Control Room точно совпадают с
идентификаторами в базе данных SSO. Интеграция SSO завершится сбоем для несовпадающих
идентификаторов.

Related concepts
Получить лицензию на миграцию on page 1181
Миграция доступна бесплатно. Для миграции в среду Automation 360 (Cloud или On-Premises)
необходимо запросить лицензию на миграцию.
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Загрузка данных Enterprise 11 с помощью Утилиты миграции Cloud
Используйте Утилиту миграции Cloud для сбора данных Enterprise 11 и их загрузки в Automation
Anywhere Cloud.
Прежде чем начинать загрузку данных в Automation 360, проверьте, что выполнены все
предварительные условия. См. раздел Предварительные условия для миграции Cloud on page 1191.

Note:  Остановите службу Automation Anywhere Control Room Reverse Proxy.
Если решение Enterprise 11 установлено в кластере, остановите службу Automation Anywhere Control
Room Reverse Proxy на всех узлах в кластере.

1. Запустите Утилиту миграции Cloud от имени администратора.
2. Выберите Подключиться к Интернету по прокси, если вы хотите подключиться к Интернету

с помощью прокси-сервера, а затем щелкните Начать.
a) Укажите имя хоста или IP-адрес прокси-сервера в поле Имя хоста/IP-адрес

прокси-сервера.
b) Укажите порт, который вы хотите использовать для подключения к прокси-серверу, в поле

Порт.
c) Выберите параметр Аутентификация, если прокси-сервер требует аутентификации.
d) Укажите учетные данные, которые вы хотите использовать для аутентификации в полях

Имя пользователя и Пароль.

3. На экране Подключение к Control Room введите следующие данные о среде Enterprise 11.

Important:  These fields are automatically populated with the required values from the Enterprise
11 environment when the Cloud migration utility is run on the same application server where the
Enterprise 11 Control Room is installed.

Поскольку вы можете выполнить миграцию только одной Control Room за раз, проверьте, что
путь установки, путь к репозиторию и данные базы данных относятся к одной и той же Control
Room.

Поле Значение

Путь установки Место, где установлена Control Room. The
Installation path value is auto-populated to
ensure that the details match with the Control
Room database.

Note:  Network path is not supported as an
Installation Path value.

Путь к репозиторию Место, где хранится репозиторий Control
Room.
The Repository Path value is automatically
populated and cannot be edited. This is to ensure
that the details match those in theControl Room
database.

IP-адрес/имя хоста IP-адрес или имя хоста сервера базы данных.
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Поле Значение

Порт Порт, который используется для подключения
к серверу базы данных.

Имя базы данных Имя базы данных Control Room, которую вы
хотите загрузить.

Безопасное подключение Параметр, чтобы использовать безопасное
подключение для соединения с базой данных.

Аутентификация Authentication method that you want to use:
• Аутентификация Windows. Выберите

этот параметр, чтобы использовать
аутентификацию Windows для установки
подключения к серверу базы данных.

Note:  The user who is logged in to the
Enterprise 11 server and is running the Cloud
migration utility must be a Windows user
administrator with db_owner permission to
the Enterprise 11 database.

• Аутентификация SQL. Выберите этот
параметр, чтобы использовать учетные
данные базы данных для аутентификации
при установке подключения к серверу базы
данных.
Если вы выбрали этот параметр, укажите
учетные данные, которые необходимо
использовать для подключения к серверу
базы данных в полях Имя пользователя
и Пароль.

Путь резервного копирования Место, где вы хотите хранить резервную
копию данных Enterprise 11 Control Room.

4. Щелкните Вперед.
5. На экране Сводка ознакомьтесь с информацией и щелкните Далее.
6. На экране Проверить код миграции введите код миграции, полученный по электронной

почте, и щелкните Проверить.
Система проверяет введенный вами код миграции.

7. Щелкните Вперед.
Система извлекает данные Enterprise 11 и начинает передавать данные в Automation Anywhere
Cloud.

8. Щелкните Выйти.
После успешной загрузки данных вы получите электронное письмо со ссылкой и учетными
данными для входа в Control Room.

See the following video on how to upload Enterprise 11 data using the Cloud Migration Utility:

See the following video on how to verify the Enterprise 11 data in the Cloud Control Room:

Миграция корпоративных боты on page 1227
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Подготовка к миграции при параллельном использовании Enterprise 11
и Automation 360 Cloud
Выполните задачи этого потока операций, если вы хотите использовать Automation 360 Cloud и
Enterprise 11 параллельно. Вы можете продолжать использовать обе среды до тех пор, пока не
будете готовы начать миграцию с Enterprise 11 на Automation 360 Cloud.
1. Проверьте, что вы выполнили следующие задачи для проверки готовности к миграции

Проверьте готовность к миграции on page 1142.
2. Проверьте, что вы приобрели и активировали лицензию на миграцию.

Получить лицензию на миграцию on page 1181

Important:
• Миграция выполняется в новое Cloud Control Room, которое будет создано во время миграции. Вы

не можете повторно использовать существующее Cloud Control Room для миграции.
• Вы не можете использовать утилиту миграции Cloud для загрузки данных в Cloud Control Room,

если вы выбрали стандартные SKU Automation 360 Cloud при подписании формы заказа.
Если вы хотите использовать утилиту миграции Cloud, вы должны выбрать SKU миграции
Automation 360 Cloud при подписании формы заказа.

1. Проверьте, что все переменные учетных данных, используемые в боты Enterprise 11, доступны в
Enterprise 11 Control Room.

2. Загрузите и установите утилиту миграции Cloud.
Установка утилиты миграции Cloud on page 1190

3. Используйте утилиту миграции Cloud для загрузки данных Enterprise 11 в Automation Anywhere
Cloud.
Загрузка данных Enterprise 11 с помощью Утилиты миграции Cloud on page 1193

4. Продолжайте использовать обе среды Enterprise 11 и Automation 360 параллельно.

Note:  Создайте новые боты и объекты, такие как пользователи, функции и расписания в
Automation 360.

5. Если вы создаете любой новый объект, такой как пользователи, функции или расписания (кроме
боты) в Enterprise 11 после установки Automation 360, создайте такой же объект в Automation
360.
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6. Когда вы будете готовы использовать только Automation 360 в качестве рабочей среды:
a) Если вы создали новые боты в Enterprise 11, данные загружаются в Automation 360 Cloud:

1. Экспортируйте все боты и их зависимости, которые были созданы после загрузки
данных в Automation 360 Cloud, с помощью Bot Lifecycle Management.
Export bots

2. Импортируйте все боты в Automation 360 с помощью Bot Lifecycle Management.

Импорт боты on page 2852

Note:  Если после миграции вы добавите какие-либо новые данные или информационную
панель Bot Insight либо измените существующие данные в Enterprise 11, то эти изменения
не импортируются в Automation 360 и поэтому их миграция не будет выполнена.

Предварительные задачи для миграции боты on page 1222

Подготовка к ручной миграции в Cloud Automation 360
Можно вручную выполнить миграцию из Enterprise 11 или Enterprise 10 в Cloud Automation 360 (без
использования утилиты миграции Cloud) путем создания пользователей, функций, разрешений и
других объектов, необходимых для запуска перенесенных боты.

Note:  The only way by which you can migrate from Enterprise 11 or Enterprise 10 to Automation 360
Cloud on Google Cloud Platform is by using the following procedure.

1. Проверьте, что вы выполнили следующие задачи для проверки готовности к миграции

Проверьте готовность к миграции on page 1142.
2. Проверьте, что вы приобрели и активировали лицензию на миграцию.

Получить лицензию на миграцию on page 1181

Note:  Используйте ручную миграцию в следующих сценариях.
• У вас есть существующий экземпляр Cloud Automation 360, и вы хотите перенести данные

Enterprise 11.
• Если вы хотите вручную перенести в Automation 360 только боты и повторно создать все

остальные объекты Enterprise 11 или Enterprise 10, например пользователей, функции и учетные
данные.

• Если вы хотите перенести только некоторые объекты Enterprise 11 или Enterprise 10. Например,
у вас 50 пользователей и 10 пользовательских функций в Enterprise 11 или Enterprise 10, но вы
хотите перенести в Automation 360 только 40 пользователей и 7 функций. Аналогично, если
необходимо перенести только пользователей и функции и повторно создать необходимые
расписания в Automation 360.

Для получения информации об автоматической миграции в Cloud (с помощью утилиты миграции
Cloud) см. Подготовка к миграции с Enterprise 11 в Automation 360 Cloud on page 1186.
1. Создайте все объекты Enterprise 11 или Enterprise 10 в Cloud Automation 360.

Для получения дополнительной информации об объектах, которые необходимо создать, см.
Предварительные условия для миграции вручную on page 1197.
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2. Загрузите боты:
Версия Шаги

Enterprise 11 Импорт боты on page 2852

Enterprise 10 a. Upload бот and its dependencies on page 2060
боты загружаются в личную рабочую
область в Automation 360. Убедитесь, что
вы создали такую же структуру папок в
общей рабочей области, как и в Enterprise
10 Control Room.
Загрузите все зависимые боты и другие
файлы, необходимые для запуска боты в
Automation 360. Все загруженные боты,
их зависимые боты и другие необходимые
файлы должны храниться в той же папке
в Automation 360, что и в Enterprise 10.

b. Проверьте загруженные боты, которые
доступны в личной рабочей области.
Check in a бот on page 2010

See the following video on how to manually migrate to Automation 360 using Bot Lifecycle Management:

Предварительные задачи для миграции боты on page 1222

Предварительные условия для миграции вручную
Когда вы выполняете миграцию с Enterprise 11 или Enterprise 10, если вы не использовали базу
данных Enterprise 11 или не копировали данные Enterprise 10, вы должны вручную создать все
объекты из Enterprise 11 или Enterprise 10 в Automation 360.
Создайте следующие объекты Enterprise 11 или Enterprise 10 (кроме боты) в Automation 360:
• Create a user on page 2699
• Create a role on page 2708
• Учетные данные и ячейки, используемые в боты

Credentials and ячейки in the Credential Vault on page 2855
• Глобальное значение AAApplicationPath, и установите для него такое же значение, как в

Enterprise 11 или Enterprise 10, для соответствующих пользователей
• Глобальное значение AADefaultDateFormat, и установите для него значение MM/DD/YYYY

HH:MM:SS.

© 2023 Automation Anywhere. All rights reserved.     1197



    Automation Anywhere - Миграция в Automation 360

• Следующие глобальные значения, которые будет использовать action Отправить сообщение
электронной почты:
• AAE_EmailSettings_auth
• AAE_EmailSettings_host
• AAE_EmailSettings_port
• AAE_EmailSettings_ssl

Значения для предыдущих глобальных значений должны быть такими же, какие указаны в
Enterprise 11 в разделе Инструменты > Параметры > Настройки электронной почты.
Вы должны создать глобальные «логические» значения AAE_EmailSettings_auth и
AAE_EmailSettings_ssl. Значение для них должно быть присвоено на основе конфигурации
Enterprise 11. For example, if the My server requires authentication option is selected in Enterprise
11, you must set the AAE_EmailSettings_auth value as true. Similarly, if the My server uses a
secure connection option is selected in Enterprise 11, you must set the AAE_EmailSettings_ssl value
as true.

• Следующие глобальные значения, если вы использовали Exchange Web Services (EWS) в
Enterprise 11:
• AAE_EmailSettings_tenantId
• AAE_EmailSettings_clientId
• AAE_EmailSettings_domainName

• Создайте в Automation 360 такую же структуру папок, как в Enterprise 11 или Enterprise 10.

Important:  Вы должны создать папку MetaBots в папке Bots в Automation 360, даже если у
вас нет никаких MetaBots в Enterprise 11 или Enterprise 10.

• Загрузите все боты Enterprise 11 или Enterprise 10 и их зависимости в Automation 360 Control
Room.
Вы должны загрузить боты и их зависимости в то же место, что и в Enterprise 11 или Enterprise
10.

• Выполните миграцию боты в следующей последовательности:
1. MetaBots
2. Дочерние боты
3. Родительские или основные боты

Important:  Вы должны создать все предыдущие объекты в Automation 360 так же, как они
доступны в Enterprise 11 или Enterprise 10.

Подготовка к миграции с Enterprise 11 в Automation 360 On-
Premises
Выполните задачи этого потока операций для миграции с Enterprise 11 в Automation 360 On-Premises,
включая миграцию ваших боты в Automation 360. Также выполняется миграция информационных
панелей Bot Insight для боты аналитики Enterprise 11.
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Workflow map: You can also view this migration workflow in an interactive visual format by clicking the

following schematic image:
1. Migrating from Enterprise 11 to Automation 360 On-Premises

1. Проверьте, что вы выполнили следующие задачи для проверки готовности к миграции

Проверьте готовность к миграции on page 1142.
2. Проверьте, что вы приобрели и активировали лицензию на миграцию.

Получить лицензию на миграцию on page 1181
3. При установке Automation 360 на компьютер, на котором ранее было установлено решение

Enterprise 11, вы должны удалить данные из папки данных Elasticsearch (C:/ProgramData/
elasticsearch/data).
Если расположение папки данных Elasticsearch было изменено, обновленную информацию
можно найти в файле C:\Program Files\Automation Anywhere\Enterprise
\elasticsearch\config\elasticsearch.yml.

Important:  Если вы удалите данные Elasticsearch, вы потеряете данные аудита Enterprise 11.

Note:  Установите Automation 360 на отдельный сервер, чтобы ваша среда Enterprise 11 не
пострадала от действий миграции.

1. Рекомендуется создать резервную копию базы данных Enterprise 11 и восстановить ее в том же
или другом экземпляре SQL, чтобы избежать сбоя задач автоматизации, использующих базу
данных Enterprise 11.
Quickstart: Back up and restore a SQL Server database on-premises

Миграция Bot Insight: Данные и информационные панели Bot Insight переносятся в рамках
общего процесса миграции. Для миграции клонируйте базу данных Bot Insight (которая
отличается от базы данных Enterprise 11 Control Room) и извлеките и экспортируйте метаданные
информационной панели в Automation 360 с помощью утилиты предварительной миграции Bot
Insight.

Экспорт информационных панелей Enterprise 11 Bot Insight для миграции on page 1204
The following video shows how to create a backup of the Enterprise 11 database:

2. Если вы выполняете миграцию с версии 11.3.x или более поздней, удалите данные из таблицы
ES_SETTINGS из базы данных Enterprise 11 Control Room.

3. Скопируйте и вставьте репозиторий Enterprise 11 Control Room и добавьте в базу данных
Enterprise 11 путь к репозиторию Automation 360.
Копирование информации Enterprise 11 и ее вставка в Automation 360 on page 1200
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4. Проверьте, что все переменные учетных данных, используемые в боты Enterprise 11, доступны в
Enterprise 11 Control Room.

5. Установка On-Premises Automation 360:
a) Проверьте соответствие системным требованиям.

Automation 360 On-Premises prerequisites on page 845
b) В пользовательском режиме установите Automation 360 On-Premises Control Room в

промежуточной среде.
Installing Control Room using Custom mode on page 908

Important:  Во время установки настройте Automation 360 On-Premises Control Room для
использования восстановленной базы данных Enterprise 11. Это гарантирует, что все ваши
данные Enterprise 11 будут доступны в Automation 360 как есть. Информация о том, что
переносится и что нет: Что переносится и что не переносится on page 1135.

6. После установки Automation 360 On-Premises обновите URL-адрес доступа Automation 360
в восстановленной базе данных Enterprise 11 Control Room. Этот URL-адрес доступа будет
использоваться для доступа к Control Room в Automation 360.
Для обновления URL-адреса доступа: update CONFIGURATION set value = '[Automation 360
 Control Room URL]' where category = 'CR_setup_general' and config_key = 'AccessUrl'
Пример запроса: update [Automation 360-Database].[dbo].[CONFIGURATION] set value ='http://
Automation 360-crurl.com' where config_key='AccessUrl'

Note:  Не включайте косую черту («/») в конце URL-адреса доступа, который вы указываете в
приведенной выше команде.

7. Проверьте, что все вставленные данные есть в соответствующих файлах и папках.
8. Optional: Выполните миграцию данных журнала аудита.

Миграция журналов аудита Enterprise 11 on page 1206
Чтобы узнать больше, найдите курс Миграция с Enterprise 11 в Automation 360 On-Premises в
Automation Anywhere University: RPA Training and Certification (A-People login required).

Предварительные задачи для миграции боты on page 1222
Related tasks
Подготовка к миграции с Enterprise 10 в Automation 360 On-Premises on page 1213
Выполните задачи этого потока операций для миграции с Enterprise 10 в Automation 360 On-Premises,
включая миграцию ваших боты в Automation 360.

Резервное копирование и восстановление базы данных Enterprise 11
или Enterprise 10
Перед началом миграции создайте резервную копию и восстановите базу данных Enterprise 11 или
Enterprise 10.
Quickstart: Back up and restore a SQL Server database on-premises.

Копирование информации Enterprise 11 и ее вставка в Automation 360
Для среды Automation 360 необходимы файлы репозитория сервера Enterprise 11 и файл Credential
Vault. Наиболее эффективным способом получения этих данных является их копирование из среды
Enterprise 11 в Automation 360.
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Необходимо скопировать нужные файлы из данных Enterprise 11 и вставить их перед установкой
Automation 360. Кроме того, необходимо выполнить запросы, чтобы обновить URL-адрес для доступа
к Control Room и путь к репозиторию.
Чтобы узнать больше о миграции в Automation 360, пройдите следующие курсы в Automation Anywhere
University: RPA Training and Certification (A-People login required):
• Миграция с Enterprise 11 в локальную версию Automation 360
• Миграция с Enterprise 10 в локальную версию Automation 360

1. Скопируйте и вставьте данные репозитория Enterprise 11.
Расположение репозитория Enterprise 11 можно найти в разделе Администрирование >
Настройки > Общие в Enterprise 11 Control Room.
См. раздел Configuration settings.

Remember:
• Если Enterprise 11 Credential Vault настроено в ручном режиме, скопируйте файл,

содержащий мастер-ключ, который хранится в защищенном месте Credential Vault.
Мастер-ключ требуется, если вы впервые после миграции из Enterprise 11 входите в
Automation 360 с использованием восстановленной базы данных Enterprise 11.

• Если в Enterprise 11 Control Room включено управление версиями, последние версии
каждого бот (включая зависимости) копируются и переносятся из репозитория Enterprise
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11 в Automation 360. Однако журнал версий бот и его зависимостей не будет скопирован и
перенесен.

• Если необходимо настроить конфигурацию кластера в Automation 360, вставьте
скопированные данные Enterprise 11 в общую сетевую папку, доступную для всех узлов
кластера.

• Если вы используете NAS для хранения данных репозитория Enterprise 11, а данные
репозитория Automation 360 находятся на локальном диске, используется аналогичная
процедура копирования данных Enterprise 11 из NAS на локальный диск Automation 360.

a) Создайте следующую структуру папок в любом месте на устройстве, если она еще не
существует.
Например, C:\ProgramData\AutomationAnywhere\Server Files

Note:
• Если необходимо настроить конфигурацию кластера в Automation 360, вставьте

скопированные данные Enterprise 11 в общую сетевую папку, доступную для всех узлов
кластера.

• Если ваша база данных Enterprise 11 хранится в хранилище NAS, и вы хотите перенести
ее на локальный диск Automation 360, используется аналогичная процедура копирования
и вставки.

b) Create the following folders within the Server Files folder you have created in Step a: Default
\0\Automation Anywhere\Bots

Из папок, созданных на предыдущем шаге, должна получиться следующая структура папок:
C:\ProgramData\AutomationAnywhere\Server Files\Default\0\Automation
 Anywhere\Bots

C:\ProgramData\AutomationAnywhere\Server Files в структуре папок —
динамичный путь, который при необходимости может меняться. В то время как Default
\0\Automation Anywhere\Bots — это постоянный путь, который не меняется.

Note:  Этот путь не является временным путем для миграции, он будет использоваться для
хранения всех боты и пакеты.

c) Скопируйте и вставьте файл CredentialVault.dat и папки Enterprise 11, содержащие
боты и MetaBots, в структуру папок, созданную на предыдущем шаге.

Файлы и папки
Enterprise 11 для
копирования

Расположение
Enterprise 11

Расположение
Automation 360

Файл
CredentialVault.dat

AutomationAnywhere
\Server Files

Файл
CredentialVault.dat
доступен в этом
расположении,
только если Enterprise
11 Credential Vault
настроено в режиме
Экспресс.

AutomationAnywhere
\Server Files
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Файлы и папки
Enterprise 11 для
копирования

Расположение
Enterprise 11

Расположение
Automation 360

Все файлы и папки,
включая папкиMy
 Tasks и My MetaBots

\AutomationAnywhere
\Server Files
\Default\Automation
 Anywhere\

\AutomationAnywhere
\Server Files
\Default
\0\Automation
 Anywhere\Bots\

a) Создайте папку для Automation 360 в любом месте на устройстве.
Например, D:\New project\Automation 360.

Notes:
• Если необходимо настроить конфигурацию кластера в Automation 360, вставьте

скопированные данные Enterprise 11 в общую сетевую папку, доступную для всех узлов
кластера.

• Если ваша база данных Enterprise 11 хранится в хранилище NAS, и вы хотите перенести
ее на локальный диск Automation 360, используется аналогичная процедура копирования
и вставки.

b) Создайте следующие папки в папке Automation 360, которую вы создали на предыдущем
шаге: AutomationAnywhere\Server Files\Default\0\Automation Anywhere\Bots
Из папок, созданных на предыдущем шаге, должна получиться следующая структура папок:
D:\New project\Automation 360\AutomationAnywhere\Server Files\Default
\0\Automation Anywhere\Bots

D:\New project\Automation 360 в структуре папок — динамичный путь, который при
необходимости может меняться. В то время как AutomationAnywhere\Server Files
\Default\0\Automation Anywhere\Bots — это постоянный путь, который не меняется.

c) Скопируйте и вставьте файл CredentialVault.dat и папки Enterprise 11, содержащие
боты и MetaBots, в структуру папок, созданную на предыдущем шаге.

Файлы и папки
Enterprise 11 для
копирования

Расположение
Enterprise 11

Расположение
Automation 360

Файл
CredentialVault.dat

AutomationAnywhere
\Server Files

Файл
CredentialVault.dat
доступен в этом
расположении,
только если Enterprise
11 Credential Vault
настроено в режиме
Экспресс.

AutomationAnywhere
\Server Files

© 2023 Automation Anywhere. All rights reserved.     1203



    Automation Anywhere - Миграция в Automation 360

Файлы и папки
Enterprise 11 для
копирования

Расположение
Enterprise 11

Расположение
Automation 360

Все файлы и папки,
включая папкиMy
 Tasks и My MetaBots

\AutomationAnywhere
\Server Files
\Default\Automation
 Anywhere\

\AutomationAnywhere
\Server Files
\Default
\0\Automation
 Anywhere\Bots\

See the following video on how to create the Enterprise 11 Control Room repository in the
Automation 360 server:

You must perform the following step (Step 2) on the Enterprise 11 restored database that you backed up
as part of Step 1 in Prepare for migration.
2. Обновите путь к репозиторию Automation 360 в восстановленной базе данных Enterprise 11,

выполнив следующую команду SQL:
To update the repository path, update CONFIGURATION set value = Automation 360 Control
 Room dynamic path followed by \AutomationAnywhere\Server Files where category
= 'CR_setup_general' and config_key = 'RepositoryPath'
Динамический путь в запросе — это динамический путь, куда вставлены скопированные на
предыдущем шаге данные Enterprise 11.
Пример запроса: update [Automation 360-Database].[dbo].[CONFIGURATION] set value ='C:
\ProgramData\AutomationAnywhere\Server Files' where config_key='RepositoryPath'
Путь, указанный в запросе, совпадает с динамическим путем, где скопированы данные
Enterprise 11 из примера на предыдущем шаге.
See the following video on how to restore a backed-up Enterprise 11 database:

Выполните действия, перечисленные в разделе Подготовка к миграции с Enterprise 11 в Automation 360
On-Premises on page 1198.

Экспорт информационных панелей Enterprise 11 Bot Insight для
миграции
Используйте утилиту предварительной миграции Bot Insight для экспорта метаданных
информационной панели Enterprise 11 Bot Insight (виджеты и макеты) и профиль информационной
панели в ZIP-файле. Запустите эту утилиту на устройстве Enterprise 11 и вставьте ZIP-файл в
репозиторий Automation 360, чтобы перенести информационные панели Bot Insight.
• Выполните резервное копирование Bot Insight после создания резервной копии базы данных

Enterprise 11 Control Room и восстановите ее в экземпляре Сервер SQL. При восстановлении базы
данных Bot Insight убедитесь в выполнении следующих условий.
• Используется то же имя пользователя и пароль базы данных Control Room, что и в Automation

360.
• Имя базы данных Bot Insight, которую вы восстанавливаете в среде Automation 360, будет

таким же, как и у резервной копии базы данных Enterprise 11 Bot Insight.

• Убедитесь, что среда JRE установлена на устройстве Enterprise 11.
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Important:  Миграция Bot Insight поддерживается только в том случае, если база данных
установлена на Microsoft SQL Server или если база данных Metadatabase установлена либо на
Microsoft SQL Server, либо на PostgreSQL Server. Миграция Bot Insight не поддерживается, если база
данных установлена на PostgreSQL Server.

Note:  After data is migrated from Enterprise 11 to Automation 360, ensure that the end-to-end migration
activity is completed within 90 days from the first day of data migration. After 90 days, the Bot Insight
analytical data will be deleted.

1. Загрузите последнюю версию утилиты предварительной миграции Bot Insight с сайта поддержки
Automation Anywhere.

Important:  Необходимо загрузить утилиту на устройство, где установлена Enterprise 11 Control
Room.

a) Перейдите на страницу загрузок Automation Anywhere: A-People Downloads page (Login
required).

b) Щелкните ссылку на загрузку Automation 360.
c) Open the Installation Setup folder and download the AAE_Export_BI_Dashboards_<

 version_number> file, for example, AAE_Export_BI_Dashboards_A360.23.jar.

See the following video on how to download the pre-migration utility:

2. Запустите утилиту на устройстве Enterprise 11.
a) Откройте командную строку Windows.
b) Выполните следующую команду, чтобы экспортировать информационные панели

Bot Insight в ZIP-файл: java -jar "<path_of_downloaded_utility_jar/
AAE_Export_BI_Dashboards_< version_number>.jar" -installationPath
 "<installation_path>/Enterprise" -outputDir "<path_to_save_zip_file>/
dashboards"
Например: java -jar "Downloads/AAE_Export_BI_Dashboards_A360.23.jar " -
installationPath "C:/Program Files/Automation Anywhere/Enterprise" -
outputDir "E:/AA/work/release/A360/migration/dashboard"
Утилита сгенерирует файл dashboards.zip в указанном вами каталоге вывода.

Note:  Кроме того, можно использовать двойную косую черту (\\) для запуска файла JAR.

3. Создайте папку bot-insight в расположении установки Automation 360.
Например, C:\Program Data\Automation Anywhere\Server Files\bot-insight
По этому пути C:\Program Data\Automation Anywhere\Server Files — динамический
путь, который при необходимости может меняться. Структура папок динамического пути (\bot-
insight) — это постоянный путь, который не изменяется.

4. Скопируйте файл dashboards.zip из расположения вывода и вставьте его в папку Server
 Files\bot-insight folder.

После экспорта информационных панелей в репозиторий Automation 360 выполните следующие
действия для миграции информационных панелей Bot Insight.
1. Установите Automation 360 и выполните вход в промежуточную среду Automation 360.

Installing Control Room On-Premises on page 843
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2. Перенесите боты вместе с данными и информационными панелями Bot Insight с помощью Bot
Migration Wizard.

Миграция корпоративных боты on page 1227

See the following video on how to prepare Bot Insight data for migration:

Миграция журналов аудита Enterprise 11
Утилита экспорта журналов аудита позволяет экспортировать данные журналов аудита из Enterprise
11 Control Room в файл JSON. Необходимо вставить файл JSON в репозиторий Automation 360, а
затем перенести данные журнала аудита.

Note:  Migration of audit logs from Enterprise 11 to Automation 360 is supported only for On-Premises
deployments.

Убедитесь, что вы обладаете функцией AAE_Admin или разрешением Управлять миграцией.
• Начиная с Automation 360 v.23, можно переносить данные журнала аудита из Version 11.3.5 или

более поздних версий.
• Утилита экспорта журналов аудита экспортирует информацию обо всех событиях журнала

Enterprise 11, включая те, которые в настоящее время не поддерживаются в Automation 360,
например, многофакторная аутентификация (MFA) и запуск боты с помощью командной строки.

В зависимости от текущей версии Control Room выберите один из следующих способов экспорта и
миграции данных журнала аудита:
• Для Version 11.3 и более поздних серий:

a) Загрузите последнюю версию утилиты экспорта журналов аудита с сайта поддержки
Automation Anywhere.

Important:  Необходимо загрузить утилиту на компьютер, где установлена Version 11.3
Control Room. Если Control Room установлена в режиме кластера, можно загрузить утилиту
на любой из узлов, доступных в кластере.

a. Перейдите на страницу загрузок Automation Anywhere: A-People Downloads page (Login
required).

b. Щелкните ссылку Automation 360.
c. Click Installation Setup, and then click AAE_Export_Audit_Log_v2.zip file..

b) Извлеките файлы из загруженного zip-файла.
c) Откройте командную строку Windows.
d) Change the working directory to AAE_Export_Audit_Log_v2and enter the following

command: bin\java -jar AAE_Export_Audit_Log_v2.jar export.path="OUTPUT
 LOCATION" cr.version="CONTROL ROOM VERSION" install.path="CONTROL ROOM
 INSTALLATION PATH"

Измените следующие значения в команде.
• OUTPUT LOCATION: Замените текст расположением, где необходимо сохранить результат.

• Проверьте, что папки, указанные в расположении, существуют.
• Проверьте, что вы указали расположение папки вывода в двойных кавычках.

• CONTROL ROOM VERSION: Замените текст текущей версией установленной Enterprise
11 Control Room. Значение cr.version — это первые три цифры Enterprise 11 Control
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Room. Например, если версия Control Room — Version 11.3.4.4, введите для cr.version
значение 11.3.4.

• CONTROL ROOM INSTALLATION PATH: Замените текст полным путем к папке, где
установлена Control Room. Например, C:\Program Files\Automation Anywhere
\Enterprise.

Command example: bin\java -jar AAE_Export_Audit_Log_v2.jar export.path="C:
\Migration\Audit Log" cr.version="11.3.2" install.path="C:\Program Files
\Automation Anywhere\Enterprise"

Утилита сгенерирует файл es_export.json в указанном вами расположении вывода.
Создаваемый файл JSON содержит максимум 10 000 записей. Если в данных аудита
имеется более 10 000 записей, утилита создает несколько файлов JSON в одном и том же
расположении и добавляет суффикс, например es_export_1.

e) Создайте папки migration\es-data в репозитории Automation 360.
f) Скопируйте файл JSON, доступный в расположении вывода.

Если утилита создала несколько файлов JSON, необходимо скопировать все файлы.
g) Вставьте файл JSON в папку Server Files\migration\es-data.

See the following video on exporting 11.3.x audit log data for migration:

h) Войдите в свою промежуточную среду Automation 360.
i) Перейдите к разделу Администрирование > Миграция.
j) Щелкните Перенести журнал аудита в меню Перенести боты в правом верхнем углу

экрана.
Система начинает извлекать и переносить данные журнала аудита из файла
es_export.json, а также загружать их в Elasticsearch Automation 360. Записи отображаются
на вкладке Журнал аудита в Automation 360.
После завершения миграции журнала аудита перейдите на страницу Администрирование
> Миграция, чтобы просмотреть статус миграции журнала аудита и другую связанную
информацию. Кроме того, можно отфильтровать результаты миграции журнала аудита на
основе типа миграции в качестве миграции журнала аудита.
Щелкните параметр Просмотреть миграцию для каждого экземпляра миграции аудита,
чтобы увидеть дополнительную информацию, например путь к файлу журнала аудита и
причины, по которым отдельные файлы es_export.json были пропущены или не были
перенесены во время миграции журналов аудита.

Просмотр отчетов о переносе данных on page 1315

• Для версии 11.2 и более ранних:
a) Войдите в свою промежуточную среду Automation 360.
b) Перейдите к разделу Администрирование > Миграция.
c) Щелкните Перенести данные аудита в меню Перенести ботов в правом верхнем углу

экрана.
Система начинает извлекать и переносить данные аудита из базы данных, а также загружать
их в Elasticsearch Automation 360. Записи отображаются на вкладке Журнал аудита в
Automation 360.

See the following video on migrating Enterprise 11 audit log data:

Related tasks
Просмотр отчетов о переносе данных on page 1315
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Используйте отчеты для анализа состояния миграции отдельных бот, миграции данных и миграции
журнала аудита, а также для определения состояния отдельной миграции и сводки по ней.

Подготовка к миграции при параллельном использовании Enterprise 11
и Automation 360 On-Premises
Выполните задачи этого потока операций, если вы хотите использовать Automation 360 On-Premises
и Enterprise 11 параллельно. Вы можете продолжать использовать обе среды до тех пор, пока не
будете готовы начать миграцию с Enterprise 11 на Automation 360 On-Premises.
1. Проверьте, что вы выполнили следующие задачи для проверки готовности к миграции

Проверьте готовность к миграции on page 1142.
2. Проверьте, что вы приобрели и активировали лицензию на миграцию.

Получить лицензию на миграцию on page 1181
3. При установке Automation 360 на компьютер, на котором ранее было установлено решение

Enterprise 11, вы должны удалить данные из папки данных Elasticsearch (C:/ProgramData/
elasticsearch/data).
Если расположение папки данных Elasticsearch было изменено, обновленную информацию
можно найти в файле C:\Program Files\Automation Anywhere\Enterprise
\elasticsearch\config\elasticsearch.yml.

Important:  Если вы удалите данные Elasticsearch, вы потеряете данные аудита Enterprise 11.

Note:  Установите Automation 360 на отдельный сервер, чтобы ваша среда Enterprise 11 не
пострадала от действий миграции.

1. Рекомендуется создать резервную копию базы данных Enterprise 11 и восстановить ее в том же
или другом экземпляре SQL, чтобы избежать сбоя задач автоматизации, использующих базу
данных Enterprise 11.
Quickstart: Back up and restore a SQL Server database on-premises

Миграция Bot Insight: Данные и информационные панели Bot Insight переносятся в рамках
общего процесса миграции. Для миграции клонируйте базу данных Bot Insight (которая
отличается от базы данных Enterprise 11 Control Room) и извлеките и экспортируйте метаданные
информационной панели в Automation 360 с помощью утилиты предварительной миграции Bot
Insight.

Экспорт информационных панелей Enterprise 11 Bot Insight для миграции on page 1204
2. Если вы выполняете миграцию с версии 11.3.x или более поздней, удалите данные из таблицы

ES_SETTINGS из базы данных Enterprise 11 Control Room.
3. Скопируйте и вставьте репозиторий Enterprise 11 Control Room и обновите URL-адрес доступа и

путь к репозиторию.
Копирование информации Enterprise 11 и ее вставка в Automation 360 on page 1200

4. Проверьте, что все переменные учетных данных, используемые в боты Enterprise 11, доступны в
Enterprise 11 Control Room.
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5. Установка On-Premises Automation 360:
a) Проверьте соответствие системным требованиям.

Automation 360 On-Premises prerequisites on page 845
b) В пользовательском режиме установите Automation 360 On-Premises Control Room в

промежуточной среде.
Installing Control Room using Custom mode on page 908

Important:  Во время установки настройте Automation 360 On-Premises Control Room для
использования восстановленной базы данных Enterprise 11.

6. Продолжайте использовать обе среды Enterprise 11 и Automation 360 параллельно.

Note:  Создайте новые боты и объекты, такие как пользователи, функции и расписания в
Automation 360.

7. Если вы создаете любой новый объект, такой как пользователи, функции или расписания (кроме
боты) в Enterprise 11 после установки Automation 360, создайте такой же объект в Automation
360.

8. Когда вы будете готовы использовать только Automation 360 в качестве рабочей среды:
a) Если вы создали новые боты в Enterprise 11 после установки Automation 360:

1. Экспортируйте все боты и их зависимости, которые были созданы после установки
Automation 360 с помощью Bot Lifecycle Management.
Export bots

2. Импортируйте все боты в Automation 360 с помощью Bot Lifecycle Management.

Импорт боты on page 2852

9. Optional: Выполните миграцию данных журнала аудита.
Миграция журналов аудита Enterprise 11 on page 1206

Предварительные задачи для миграции боты on page 1222

How workload management data is migrated
Enterprise 11 workload management data is automatically migrated to Automation 360 when you install
Automation 360 and point the Control Room to the restored Enterprise 11 database.
When you migrate workload management data to Automation 360, all related workload management
is moved to the Automation 360 environment, including queues, device pools, owners, and consumers.
Группы перенесенных устройств пусты, так как процесс миграции не переносит устройства.
Обновите группу устройств, указав соответствующие необслуживаемые устройства Bot Runner.

Note:  Боты that are deleted in the workload management automation records are skipped during
migration. Для таких боты в очередях рабочей нагрузки отображается состояние Неприменимо.

Боты, связанные с шаблоном рабочей нагрузки, переносятся в тот же шаблон Automation 360 с
сохранением всей информации.
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Для миграции поддерживаются следующие переменные рабочих элементов:
• $WorkItem$ — способ миграции этой переменной зависит от связанного с ней типа String, Number

и DateTime.

Сопоставление переменных для миграции on page 1293
• $WorkItemResult$ — Боты, использующие эту переменную, должны быть связаны с шаблоном

рабочей нагрузки в Enterprise 11, если вы хотите использовать ее после миграции. Если
выполняется миграция бот с переменной $WorkItemResult$ в команде, а бот не связан с
шаблоном рабочей нагрузки, то при открытии команды в Bot editor в Automation 360 возникает
ошибка.

Следующие операции переменных рабочих элементов пока не поддерживаются, и невозможно
перенести боты, использующие эти операции переменных:
• Сброс $WorkItem$
• Сброс $WorkItemResult$

Related tasks
Edit device pools on page 2653
As a Control Room user with device pool management privileges or as a device pool owner, you can edit
device pool details to customize your automation requirements.
Use Work Item variables on page 2052
You can use the Work Item variables to pass the Work Item attributes or values to the TaskBot from the
Control Room when you run the бот with the option Run bot with queue.

Подготовка к ручной миграции в On-Premises Automation 360
Можно вручную выполнить миграцию из Enterprise 11 в On-Premises Automation 360 путем создания
пользователей, функций, разрешений и других объектов, необходимых для запуска перенесенных
боты.
1. Проверьте, что вы выполнили следующие задачи для проверки готовности к миграции

Проверьте готовность к миграции on page 1142
2. Проверьте, что вы приобрели и активировали лицензию на миграцию.

Получить лицензию на миграцию on page 1181

Note:  Используйте ручную миграцию в следующих сценариях.
• У вас есть существующий экземпляр On-Premises Automation 360, и вы хотите перенести данные

Enterprise 11.
• Если вы хотите вручную перенести в Automation 360 только боты и повторно создать все

остальные объекты Enterprise 11, например пользователей, функции и учетные данные.
• Если вы хотите перенести только некоторые объекты Enterprise 11. Например, у вас

50 пользователей и 10 пользовательских функций в Enterprise 11, но вы хотите перенести в
Automation 360 только 40 пользователей и 7 функций. Аналогично, если необходимо перенести
только пользователей и функции и повторно создать необходимые расписания в Automation 360.
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• Когда вы хотите перенести объекты Enterprise 11 в Automation 360, используя недавно
установленную базу данных и сервер.

1. Установка On-Premises Automation 360:
a) Проверьте соответствие системным требованиям.

Automation 360 On-Premises prerequisites on page 845
b) В пользовательском режиме установите Automation 360 On-Premises Control Room в

промежуточной среде.
Installing Control Room using Custom mode on page 908

Important:  Необходимо установить Automation 360 с новой базой данных.

2. Создайте все объекты Enterprise 11 в On-Premises Automation 360.
Для получения дополнительной информации об объектах, которые необходимо создать, см.
Предварительные условия для миграции вручную on page 1197.

3. Экспортируйте все боты и их зависимости, которые были созданы после установки Automation
360 с помощью Bot Lifecycle Management.
Export bots

4. Загрузите боты в On-Premises Automation 360.
Импорт боты on page 2852

Предварительные задачи для миграции боты on page 1222

Подготовка миграции с Enterprise 11 на Automation 360 с
поддержкой облака
Выполните задачи этого потока операций для миграции с Enterprise 11 в Automation 360 с
поддержкой Cloud, включая миграцию боты.
При установке Automation 360 на компьютере, где ранее было установлено решение
Enterprise 11, рекомендуется удалить данные из папки данных Elasticsearch (C:\ProgramData
\elasticsearchdata).

Note:  Если расположение папки данных Elasticsearch было изменено, обновленную информацию
можно найти в файле C:\Program Files\Automation Anywhere\Enterprise\elasticsearch
\config\elasticsearch.yml.

1. Проверьте, что вы выполнили следующие задачи для проверки готовности к миграции

Проверьте готовность к миграции on page 1142.
2. Проверьте, что вы приобрели и активировали лицензию на миграцию.

Получить лицензию на миграцию on page 1181

1. Установите Automation 360 для развертывания Cloud.
Installing Control Room for Cloud-enabled deployment on page 981

2. Создайте все объекты, например пользователей, функции и учетные данные, за исключением
боты в Automation 360, так как они доступны в Enterprise 11.
Предварительные условия для миграции вручную on page 1197
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3. Экспортируйте все боты Enterprise 11 и их зависимости, которые вы хотите перенести в
Automation 360 с помощью Bot Lifecycle Management.
Export bots

4. Импортируйте все боты Enterprise 11 в Automation 360 с помощью Bot Lifecycle Management.
Импорт боты on page 2852

5. Optional: Выполните миграцию данных журнала аудита.
Миграция журналов аудита Enterprise 11 on page 1206

Предварительные задачи для миграции боты on page 1222

Подготовка к миграции с Enterprise 11 в Automation 360 на
Linux CentOS
Выполните задачи этого потока операций для миграции с Enterprise 11 в Automation 360 On-Premises
на Linux CentOS, включая миграцию боты в Automation 360. Если бот Enterprise 11 включен для
аналитики, также выполняется миграция связанных с ним данных и информационной панели
бизнес-аналитики Bot Insight.

Note:  Создайте новую среду для миграции Automation 360, чтобы избежать проблем с
существующими боты из-за действий по миграции.

1. Рекомендуется создать резервную копию базы данных Enterprise 11 и восстановить ее в том же
или другом экземпляре SQL, чтобы избежать сбоя задач автоматизации, использующих базу
данных Enterprise 11.
Quickstart: Back up and restore a SQL Server database on-premises

2. Если вы выполняете миграцию с Version 11.3.5 или более поздних версий, вы должны удалить
данные из таблицы ES_SETTINGS из базы данных Enterprise 11 Control Room.

3. Проверьте, что все переменные учетных данных, используемые в боты Enterprise 11, доступны в
Enterprise 11 Control Room.

4. Скопируйте и вставьте репозиторий Enterprise 11 Control Room:
a) Use the sudo mkdir -p /opt/automationanywhere/enterprise/appdata/ command

to create the required Automation 360 folders.
b) Use the sudo chmod -R 775 /opt/automationanywhere command to provide the required

permissions for the folders.
c) Use the sudo mv command to copy the Enterprise 11 repository and paste it in the

automationanywhere/enterprise/appdata/ location.
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5. Обновите URL-адрес доступа к Control Room и путь к репозиторию, выполнив следующие
команды SQL на восстановленной базе данных Enterprise 11:
a) Для обновления URL-адреса доступа: update CONFIGURATION set value = '[Automation360

 Control Room URL]' where category = 'CR_setup_general' and config_key = 'AccessUrl'
Пример запроса: update [Automation360-Database].[dbo].[CONFIGURATION] set value
='http://Automation360-crurl.com' where config_key='AcessUrl'

Note:  Не включайте косую черту («/») в конце URL-адреса доступа, который вы указываете
в приведенной выше команде.

b) Для обновления пути к репозиторию: update CONFIGURATION set value = /opt/
automationanywhere/enterprise/appdata/Server Files where config_key =
'RepositoryPath'

6. Установка On-Premises Automation 360:
a) Проверьте соответствие системным требованиям.

Automation 360 On-Premises prerequisites on page 845
b) В пользовательском режиме установите Automation 360 On-Premises Control Room в

промежуточной среде.
Installing Control Room on Linux on page 953

Important:  Во время установки настройте Automation 360 On-Premises Control Room для
использования восстановленной базы данных Enterprise 11.

7. Optional: Выполните миграцию данных журнала аудита.
Миграция журналов аудита Enterprise 11 on page 1206

Предварительные задачи для миграции боты on page 1222

Подготовка к миграции с Enterprise 10 в Automation 360 On-
Premises
Выполните задачи этого потока операций для миграции с Enterprise 10 в Automation 360 On-Premises,
включая миграцию ваших боты в Automation 360.
Workflow map: You can also view this migration workflow in an interactive visual format by clicking the

following schematic image:
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1. Migrating from Enterprise 10 to Automation 360 On-Premises

1. Проверьте, что вы выполнили следующие задачи для проверки готовности к миграции

Проверьте готовность к миграции on page 1142.
2. Проверьте, что вы приобрели и активировали лицензию на миграцию.

Получить лицензию на миграцию on page 1181

Note:  Установите Automation 360 на отдельный сервер, чтобы ваша среда Enterprise 10 не
пострадала от действий миграции.

1. Рекомендуется создать резервную копию базы данных Enterprise 10 и восстановить ее в том же
или другом экземпляре SQL, чтобы избежать сбоя задач автоматизации, использующих базу
данных Enterprise 10.
Quickstart: Back up and restore a SQL Server database on-premises

2. Проверьте, что все переменные учетных данных, используемые в боты Enterprise 10, доступны в
Enterprise 10 Control Room.

3. Установка On-Premises Automation 360:
a) Проверьте соответствие системным требованиям.

Automation 360 On-Premises prerequisites on page 845
b) В пользовательском режиме установите Automation 360 On-Premises Control Room в

промежуточной среде.
Installing Control Room using Custom mode on page 908

Important:  Необходимо установить Automation 360 с новой базой данных.

c) Настройте такую же аутентификацию в Automation 360, как в Enterprise 10.
Не переключайте типы аутентификации между Enterprise 10 и Automation 360. Например,
если в Enterprise 10 в качестве аутентификации установлен Active Directory, вы должны
настроить Active Directory в качестве аутентификации и в Automation 360.

4. Скопируйте данные Enterprise 10 в Automation 360.
Копирование данных Enterprise 10 on page 1217

5. Создайте глобальное значение AAApplicationPath в Automation 360 и установите такое же
значение, как в Enterprise 10.
Миграция из Enterprise 10 on page 1247

6. Выполните задачи перед миграцией.
Задачи перед миграцией

Миграция корпоративных боты on page 1227

Процедура копирования данных Enterprise 10 в Automation 360
Пользователи, функции, лицензии, учетные данные, боты и расписания Enterprise 10 копируются в
Automation 360 во время процесса копирования данных.
Система копирует данные Enterprise 10 в следующем порядке:
1. Функции
2. Пользователи
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3. Учетные данные
4. Боты
5. Расписания

Если по какой-либо причине в процессе копирования элемент этой последовательности оказывается
пропущенным, то все связанные с ним элементы также пропускаются и не переносятся. Например,
если функция «Bot_Manager» не переносится, а пользователь «Jane_Smith» принадлежит только к
этой функции, то соответствующая учетная запись пользователя и любые учетные данные, боты или
расписания, связанные с этой функцией, также не будут перенесены.

Enterprise 10
элементов

Копирование элементов Enterprise 10 в Automation 360

Пользователи Если вы копируете пользователей Enterprise 10 в первый раз и система
обнаруживает пользователя с таким же именем в Automation 360, в
процессе миграции к имени пользователя Enterprise 10 будет добавлен
суффикс, например «_1», «_2» и т. д., а затем переименованный
пользователь будет скопирован в Automation 360. Например,
дублирующееся имя пользователя «Jane_Smith» в Automation 360
будет изменено на «Jane_Smith_1». В ходе последующих операций
копирования данных ранее перенесенные пользовательские данные
будут пропущены.
Дублирующиеся пользователи Active Directory системой не
переносятся. Если в Automation 360 уже существует пользователь
домена с указанным именем, в процессе миграции этот пользователь и
его зависимости будут пропущены.

Функции При первом копировании функций Enterprise 10 дублирующиеся
системные и пользовательские функции обрабатываются процессом
миграции по-разному. В ходе миграции системные функции Enterprise
10 сопоставляются с системными функциями Automation 360.
Например, функция администратора и базовая функция Enterprise
10 сопоставляются с функциями «AAE_Admin» и «AAE_Basic»
соответственно.
Если в Enterprise 10 и Automation 360 уже существует пользовательская
функция с указанным именем, то в процессе миграции к этому
имени будет добавлен суффикс, например «_1», «_2» и т. д., а затем
переименованная функция будет скопирована в Automation 360.
Например, дублирующаяся функция «Sales_Operations» в Automation
360 будет изменена на «Sales_Operations_1».
В ходе последующих операций копирования данных ранее
перенесенные функции будут пропущены.

Лицензии В процессе миграции назначенные пользователю лицензии будут
перенесены автоматически, но не будут отображены в отчете о
миграции. Если Automation 360 Control Room имеет меньше лицензий
Bot Creator или Bot Runner, чем Enterprise 10 Control Room, и все
лицензии Automation 360 использованы, то новым перенесенным
пользователям не будут назначены лицензии. Система переносит этих
пользователей и связанные с ними данные без назначения новых
лицензий.
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Enterprise 10
элементов

Копирование элементов Enterprise 10 в Automation 360

Учетные данные Для системных учетных данных, связанных с перенесенным
пользователем, система переносит только системные учетные данные
настроек электронной почты и настроек автоматического входа.
Что касается учетных данных, созданных администратором Control
Room, система создает ячейку AAE_10x_Credentials в Credential
Vault Automation 360 и добавляет учетные данные из Enterprise
10 в качестве стандартных учетных данных. Система назначает
пользователя, осуществляющего миграцию данных Enterprise 10,
владельцем ячейки AAE_10x_Credentials, а все пользовательские
функции — потребителями этой ячейки. Если ячейка с именем
AAE_10x_Credentials уже существует в Automation 360, система
добавляет перенесенные учетные данные в эту ячейку.

Note:
• Если количество атрибутов учетных данных превышает 50,

миграция не поддерживается.
• Пользователи, которым в Enterprise 10 присвоена только

функция AAE_Basic, должны получить пользовательскую
функцию в Automation 360, чтобы стать потребителем ячейки
AAE_10x_Credential.

Для MetaBots, которые содержат экраны в качестве активов и
используют переменные типа «Пароль» на этих экранах, в Automation
360 создаются эквивалентные переменные типа «Компонент учетных
данных». Если переменная типа «Пароль» в MetaBot является входной
переменной и значение этой переменной передается от родительского
бот в Enterprise 10, выполните следующие действия перед запуском
перенесенных боты.
1. Создайте компонент учетных данных с помощью параметра

Стандартный, выбранного в качестве входного параметра.
2. Создайте ячейку и используйте компонент учетных данных,

созданный на предыдущем шаге, в этой ячейке.
3. Используйте созданный вами компонент учетных данных в

перенесенном родительском бот, чтобы передать его дочернему
объекту боты.

Если вы использовали переменную массива в цикле для передачи
нескольких значений в переменную типа «Пароль», используемую в
MetaBot, перенесенный бот использует созданный вами компонент
учетных данных для передачи одного значения.
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Enterprise 10
элементов

Копирование элементов Enterprise 10 в Automation 360

Боты Если бот с одинаковым именем существует в Enterprise 10 и Automation
360, миграция бот и связанное с ней расписание будут пропущены
в ходе процесса копирования данных. Commands that use credential
variables in Enterprise 10 боты use the AAE_10x_Credentials locker
after migration.
If your Enterprise 10 Control Room is configured with SVN version control,
then the copy data process also copies the latest version of each бот
including the dependencies from the Enterprise 10 repository to the
Automation 360 repository. Use the бот migration wizard to migrate the
Enterprise 10 боты to Automation 360. However, the version history of the
бот and its dependencies are not copied and migrated.

Note:  Migration of the production version of Enterprise 10 боты is
currently not supported. As a workaround, make or set the current
production version of the боты as the latest version and then migrate the
боты.

Расписания Если в обоих окружениях существуют дублирующиеся расписания,
дублирующееся расписание переносится и в Automation 360 возникает
два расписания с одинаковым именем.
При миграции расписания произойдет сбой, если связанный
пользователь не существует в Automation 360.

See the following video on how to review the copied Enterprise 10 data in Automation 360:

Related tasks
Копирование данных Enterprise 10 on page 1217
Необходимо скопировать данные Enterprise 10 в Automation 360 перед преобразованием боты
Enterprise 10.
Включение расписаний после миграции on page 1254
Когда вы копируете данные Enterprise 10 в Automation 360, выполняется миграция расписаний
Enterprise 10. Миграция расписаний версии Enterprise 11 выполняется при обновлении данных
Enterprise 11 до Automation 360.

Копирование данных Enterprise 10
Необходимо скопировать данные Enterprise 10 в Automation 360 перед преобразованием боты
Enterprise 10.
Пользователь, выполняющий эту задачу, должен обладать функцией AAE_Admin.
1. Войдите в свою промежуточную среду Automation 360.
2. Щелкните Администрирование > Миграция.
3. Щелкните Копировать данные 10.x.
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4. Предоставьте следующую информацию на странице ОБЩИЕ.
Вариант Действие

Имя Введите имя переноса или используйте имя по
умолчанию. В имени переноса по умолчанию
содержится имя пользователя, который вошел
в систему, текущая дата и метка времени.

Описание Введите описание миграции.

5. Щелкните Вперед.
6. Предоставьте следующую информацию на странице БАЗА ДАННЫХ.

Вариант Действие

Использовать безопасное подключение Выберите этот параметр, чтобы использовать
безопасное подключение для соединения с
базой данных.

Имя хоста сервера Введите имя хоста сервера базы данных,
содержащей данные Enterprise 10, которые
необходимо перенести.

Порт сервера Введите порт, который нужно использовать
для подключения к серверу базы данных.

Использовать учетные данные базы
данных

Выберите этот параметр, чтобы использовать
учетные данные базы данных для
аутентификации при установке подключения к
серверу базы данных.
Если вы выбрали этот параметр, укажите
учетные данные, которые необходимо
использовать для подключения к серверу
базы данных в полях Имя пользователя и
Пароль.

Использовать аутентификацию Windows Выберите этот параметр, чтобы использовать
аутентификацию Windows для установки
подключения к серверу базы данных.

Important:  Этот параметр работает, только
если во время установки была настроена
учетная запись домена, которая имеет
разрешения на чтение и запись для базы
данных Enterprise 10.

Имя базы данных Введите имя базы данных, содержащей
данные Enterprise 10, которые необходимо
перенести.

Подключить Выберите этот параметр, чтобы установить
подключение к базе данных.

7. Щелкните Вперед.
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8. Предоставьте следующую информацию на странице РЕПОЗИТОРИЙ.
Вариант Действие

Путь к репозиторию Введите расположение восстановленных
данных Enterprise 10, доступных на
устройстве.

Мастер-ключ Введите мастер-ключ для Enterprise 10.

Проверить Выберите этот параметр, чтобы проверить
подключение перед копированием данных
Enterprise 10.

9. Щелкните Копировать данные.

See the following video on how to copy Enterprise 10 data to Automation 360:

Создайте глобальное значение AAApplicationPath в Automation 360
Related concepts
Процедура копирования данных Enterprise 10 в Automation 360 on page 1214
Пользователи, функции, лицензии, учетные данные, боты и расписания Enterprise 10 копируются в
Automation 360 во время процесса копирования данных.
Related tasks
Включение расписаний после миграции on page 1254
Когда вы копируете данные Enterprise 10 в Automation 360, выполняется миграция расписаний
Enterprise 10. Миграция расписаний версии Enterprise 11 выполняется при обновлении данных
Enterprise 11 до Automation 360.

Подготовка к миграции при параллельном использовании Enterprise 10
и Automation 360 On-Premises
Выполните задачи этого потока операций, если вы хотите использовать Automation 360 On-Premises
и Enterprise 10 параллельно. Вы можете продолжать использовать обе среды до тех пор, пока не
будете готовы начать миграцию с Enterprise 10 на Automation 360 On-Premises.
1. Проверьте, что вы выполнили следующие задачи для проверки готовности к миграции

Проверьте готовность к миграции on page 1142.
2. Проверьте, что вы приобрели и активировали лицензию на миграцию.

Получить лицензию на миграцию on page 1181

Note:  Создайте новую среду для миграции Automation 360, чтобы избежать проблем с
существующими боты из-за действий по миграции.

1. Рекомендуется создать резервную копию базы данных Enterprise 11 и восстановить ее в том же
или другом экземпляре SQL, чтобы избежать сбоя задач автоматизации, использующих базу
данных Enterprise 11.
Quickstart: Back up and restore a SQL Server database on-premises

2. Проверьте, что все переменные учетных данных, используемые в боты Enterprise 11, доступны в
Enterprise 11 Control Room.
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3. Установка On-Premises Automation 360:
a) Проверьте соответствие системным требованиям.
b) В пользовательском режиме установите Automation 360 On-Premises Control Room в

промежуточной среде.
Installing Control Room using Custom mode on page 908

Important:  Необходимо установить Automation 360 с новой базой данных.

4. Выполните задачи перед миграцией.
Задачи перед миграцией

5. Создайте глобальное значение AAApplicationPath в Automation 360 и установите такое же
значение, как в Enterprise 10.
Сопоставление переменных для миграции on page 1293

6. Скопируйте данные Enterprise 10 в Automation 360.
Копирование данных Enterprise 10 on page 1217

7. Продолжайте использовать обе среды Enterprise 10 и Automation 360 параллельно.

Note:  Создайте новые боты и объекты, такие как пользователи, функции и расписания в
Automation 360.

8. Если вы создаете любой новый объект, такой как пользователи, функции, расписания и боты в
Enterprise 10 после установки Automation 360, создайте такой же объект в Automation 360.

9. When you are ready to use only Automation 360 as your production environment:
If you have created new боты or updated the existing ones in Enterprise 10 after installing
Automation 360, based on your environment, follow these steps:
• Applies from v.24 onwards:

a. Export all the боты and their dependencies that were created after Automation 360 was
installed using the export utility.

Миграция новых или измененных боты Enterprise 10 в Automation 360 on page 1220
b. Import all the боты to Automation 360 using Bot Lifecycle Management.

Импорт боты on page 2852

• Applies to v.23 and previous versions
a. Copy all the боты and their dependencies from Enterprise 10 by using the Copy 10.x data

option in the Automation 360.
b. Login as the Bot Creator to upload the боты and their dependencies to the Automation 360

private workspace. Note that the folder structure of the боты and their dependencies must be
same as that of version Enterprise 10.

c. Check in the боты to the public workspace.

Миграция корпоративных боты on page 1227

Миграция новых или измененных боты Enterprise 10 в Automation 360
Утилита экспорта Enterprise 10 позволяет выполнять миграцию новых или измененных боты
Enterprise 10 в Automation 360 после предыдущей миграции.
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Используйте утилиту экспорта для создания пакета .aapkg, который можно импортировать с
помощью Bot Lifecycle Management и затем перенести в Automation 360 с помощью Bot Migration
Wizard.
1. Загрузите последнюю версию утилиты экспорта бот с сайта поддержки Automation Anywhere.

a) Перейдите на страницу загрузок Automation Anywhere: A-People Downloads page (Login
required).

b) Щелкните ссылку Automation 360.
c) Щелкните Настройка установки, а затем щелкните файл

AAE_Export_Legacy_Bots_v1.zip.

2. Извлеките файлы из загруженного zip-файла.
3. Откройте командную строку Windows.
4. Измените рабочий каталог на AAE_Export_Legacy_Bots_v1 и введите следующую команду:

bin\java -jar AAE_Export_Legacy_Bots_v1.jar -INPUT="INPUT LOCATION" -
OUTPUT="OUTPUT LOCATION" -INCLUDE_SUBFOLDERS.
Измените следующие значения в команде.
• INPUT. Измените текст на путь к файлу или путь к папке из репозитория Control Room, из

которого необходимо экспортированы файлы бот (файлы .atmx и .mbot).
• Проверьте, что папки, указанные в расположении, существуют.
• Проверьте, что вы указали расположение папки ввода в двойных кавычках.

• OUTPUT. Измените текст на расположение вывода, где вы хотите хранить экспортированные
файлы бот в пакете (.aapkg) с отметкой времени.
• Проверьте, что папки, указанные в расположении, существуют.
• Проверьте, что вы указали расположение папки вывода в двойных кавычках.

• INCLUDE_SUBFOLDERS. Задайте этот параметр (необязательно), чтобы указать, будут ли
файлы бот из вложенных подпапок репозитория Control Room экспортированы или нет.

Command example to export folder: bin\java -jar AAE_Export_Legacy_Bots_v1.jar -
INPUT="E:\Migration10x\Automation Anywhere Server Files\Default\Automation
 Anywhere\My Tasks\10X\Sample_Tasks" -OUTPUT="F:\10x-Export-Utility
\Exported-Bots"
Command example to export file: bin\java -jar AAE_Export_Legacy_Bots_v1.jar -
INPUT="E:\Migration10x\Automation Anywhere Server Files\Default\Automation
 Anywhere\My Tasks\10X\AutomationTask.atmx" -OUTPUT="F:\10x-Export-Utility
\Exported-Bots"
Утилита сгенерирует файл .aapkg в указанном вами расположении вывода.

5.

1. Выберите Автоматизация > Импортировать боты, чтобы импортировать файл пакета
.aapkg в Automation 360.

Импорт боты on page 2852
2. Выберите Администрирование > Миграция, чтобы выполнить миграцию боты

(преобразовать файл .atmx в .bot) в Automation 360 с помощью Bot Migration Wizard.

Миграция корпоративных боты on page 1227
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Предварительные задачи для миграции боты
После настройки Automation 360 вы должны выполнить определенные задачи перед миграцией боты
Enterprise 11 или Enterprise 10.
• Лицензии:

• For migration to be successful, the license requirements of the target  environments must match the
existing source  or  environments.

• At least one  license is required for migration.

• Функции:
Присвойте функцию AAE_Bot Migration Admin пользователю, который будет инициировать
миграцию, и пользователю Bot Runner, который будет выполнять миграцию. У пользователя
Bot Runner, выполняющего миграцию, должны быть соответствующие разрешения, и он должен
соответствовать следующим критериям:
• Необслуживаемая лицензия Bot Runner
• Статус Автоматический вход задан
• Настроенное устройство по умолчанию

See the following video on how to create an Admin user to initiate бот migration:

See the following video on how to create a Bot Runner user to perform the бот migration:

• Настройки Control Room:
• Пользователи Enterprise 11, которые установили Automation 360, используя свежую базу

данных, и пользователи Enterprise 10, которые не копировали данные Enterprise 10,
должны вручную создать все объекты Enterprise 11 или Enterprise 10, за исключением
боты, в Automation 360. Для получения дополнительной информации об объектах, которые
необходимо создать, см. Предварительные условия для миграции вручную on page 1197.

• Bot Agent. Установите Bot Agent на устройство, которое вы хотите использовать для миграции:
Установка Bot Agent и регистрация устройств on page 1046.
See the following video on how to install the Bot Agent on the device identified for бот migration:

• Боты. To migrate the production version of боты, import the Enterprise 11 боты using the Bot
Lifecycle Management feature from the SVN version control enabled Enterprise 11 Control Room. См.
раздел Импорт боты on page 2852.

Следующие шаги

Миграция корпоративных боты on page 1227

Миграция и проверка боты
Выполните задачи этого потока операций для преобразования боты в формат Automation 360 и для
их проверки после миграции.
Убедитесь, что вы выполнили все задачи по подготовке вашей среды Automation 360 к миграции:
Подготовка новой Control Room для миграции on page 1183.
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1. Перенесите боты Enterprise 11 и Enterprise 10 в Automation 360: Миграция корпоративных боты
on page 1227.

2. Убедитесь, что миграция успешно выполнена:
• Просмотр отчетов о переносе данных on page 1315
• Проверка миграции бот on page 1314
• Экспортировать в CSV on page 1316
• Просмотр изменений в перенесенных боты с помощью Бот Assistant on page 1317

See also the following video on migrating, testing, and updating your migrated боты:

Bot Migration Wizard
Этот мастер интегрирован в Control Room в Automation 360 и предоставляет инструкции в процессе
миграции после выполнения предварительных условий. You can migrate multiple боты and their
dependent боты using this wizard.
Bot Migration Wizard выполняет миграцию бот только в том случае, если все компоненты,
используемые в этом бот, поддерживаются для миграции. Если бот использует другие зависимые
файлы, такие как .txt, .doc и .png, вам придется добавить эти файлы в качестве зависимостей
вручную после миграции боты.
Можно также использовать Перенос ботовпакет для миграции отдельных боты. Однако не
рекомендуется использовать этот пакет, поскольку он не позволяет выполнить миграцию
зависимостей бот и других объектов, которые необходимы для запуска бот после миграции.
In the Control Room (Administration > Migration > Overview) tab, you can get a consolidated view
of the status of migrated боты.

Вкладка «Обзор»
Important:  Для просмотра этой вкладки
необходимо иметь разрешения Просмотр
миграции и Управлять миграцией.

Вы можете просмотреть общий статус миграции
бот, включая следующие сведения.
• Боты, миграция которых выполнена успешно
• Боты, при миграции которых произошел сбой
• Боты, при миграции которых появилось

сообщение о проверке
• Боты, при миграции которых появилось

сообщение «Требуется действие»
• История миграции. Информация о прошлых

миграциях, которые были запущены из
определенной папки или из всех папок.
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Можно также выполнить указанные ниже
действия.
• Повторно запустите миграцию для выбранных

боты и просмотрите историю каждого бот,
который прошел через несколько миграций.

• Просмотрите время, когда бот был перенесен,
используя метку времени.

• Получите сводный подсчет боты, которые
были перенесены успешно, при миграции
которых произошел сбой, и тех, которые
требуют вашей проверки или действия.

• Экспорт списка определенных боты.
• Просмотр версии перенесенного бот.
• Просмотр истории версий перенесенного бот

(сообщение о загрузке указывает, что бот
переносится из устаревших версий Enterprise
10 и Enterprise 11).
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To view the updated status of the remigrated бот, you can refresh either the table or the screen, shown in
the following

image.
Посмотрите следующее видео, чтобы узнать, как преобразовать Enterprise 11 или боты 10.x в
формате .atmx и .mbot в формат .bot в Automation 360. Эта задача выполняется после репликации
базы данных Enterprise 11 или Enterprise 10 и после того, как боты стали доступны в Automation 360
Control Room.

Рекомендации при миграции и проверке боты
Процесс миграции разработан таким образом, чтобы проходить без перебоев в работе. Узнайте,
чего следует ожидать во время преобразования, проверки и миграции боты, чтобы вы могли
выполнять свои ежедневные автоматизированные процессы как обычно.

Время, затраченное на миграцию Время миграции будет зависеть от количества
боты в вашем репозитории Enterprise 11 или
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Enterprise 10, количества автоматизируемых
процессов, а также количества Bot Runner и
компьютеров, выполняющих миграцию. Время,
необходимое для миграции, зависит от ваших
внутренних процессов и требований.

Note:  After data is migrated from Enterprise 11
to Automation 360, ensure that the end-to-end
migration activity is completed within 90 days from
the first day of data migration. After 90 days, the
Bot Insight analytical data will be deleted.

На время, необходимое для миграции, влияют
следующие факторы:
• Количество и сложность боты
• Количество строк в бот
• Конфигурация Control Room и Bot Agent
• Текущая нагрузка на Control Room

(определяется количеством пользователей,
подключенных к Control Room в определенное
время)

• Среда миграции: выполняется ли миграция
в изолированной производственной или
промежуточной среде.
Миграция в изолированной среде
выполняется быстрее.

• Находятся ли боты для миграции в одной
папке или в нескольких папках
Миграция Боты в одной папке выполняется
быстрее.

• Требования к аппаратному обеспечению
устройства, на котором выполняется
миграция

• Пропускная способность сети
• Public repository size: When you run the Bot

Migration Wizard on a Git public repository that
is larger than 1 GB and contains more than
50,000 files or objects, the migration time might
be impacted.

Миграция в вашем темпе Инструменты миграции предоставляют вам
контроль над тем, что и когда переносить. Вы
можете выбрать миграцию всех ваших боты
одновременно или несколько боты по очереди.
В течение переходного периода от Enterprise 11
или Enterprise 10 к Automation 360 вы можете
продолжать запускать боты на предыдущей
платформе как обычно до завершения миграции.

Note:  После завершения миграции все новые
боты должны создаваться в Automation 360. Это
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поможет вам управлять своими боты и вашей
организацией для перехода.

Нулевое время простоя Миграция не влияет ни на запланированные
боты, ни на возможность запланированного
запуска боты в Enterprise 11 или Enterprise
10, когда вы переносите данные в Automation
360. Пока ваши требования к инфраструктуре
соответствуют вашим потребностям в
автоматизации, и вы запускаете Enterprise 11
или Enterprise 10 и Automation 360 параллельно,
не должно быть никаких пауз в регулярных
действиях по автоматизации.

Параллельный запуск Enterprise 11 или
Enterprise 10 и Automation 360

В течение переходного периода мы рекомендуем
клиентам запускать автоматизацию в Enterprise
11 или Enterprise 10, пока перенесенные боты
не будут протестированы и успешно запущены
в Automation 360. Это лучший способ исключить
простои.

Миграция корпоративных боты
The бот migration process uses the Bot Migration Wizard to convert Enterprise 11 or Enterprise 10 боты
(TaskBots and MetaBots) in .atmx and .mbot format to the .bot format used in Automation 360 and
uploads the successfully migrated боты to the Control Room public workspace.
Убедитесь в выполнении всех необходимых задач для миграции боты. Предварительные задачи для
миграции боты on page 1222.
Во время миграции все ручные зависимости от боты автоматически преобразуются в зависимости
Control Room. Действие Копировать файл Control Room копирует эти зависимости из Control
Room в соответствующие места.
1. Войдите в свою промежуточную среду Automation 360.
2. Щелкните Администрирование > Миграция.

Note:  Если вы перенесли боты с Enterprise 10 на Enterprise 11, то информация об этой
миграции не отображается на странице Список переносов.
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3. На экране Bot Migration Wizard щелкните Перенос ботов.

4. Select the options and configuration as required in the the Settings tab.
Вариант Действие

Имя Введите имя переноса или используйте имя по
умолчанию. В имени переноса по умолчанию
содержится имя пользователя, который вошел
в систему, текущая дата и метка времени.

Описание Введите описание миграции.

Перезаписать, если бот с таким именем
существует

Выберите эту настройку, чтобы перезаписать
существующий бот, если бот с таким же
именем существует в папке.

Exclude bot dependencies Select this option to exclude child боты of sub-
tasks from migration or updating. By selecting
this flag, you can now choose to migrate parent
and child боты separately or independently.
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Вариант Действие

Использовать устаревшее поведение
"Строка ячейки Excel"

Выберите эту настройку, если вы переходите
с версии, более ранней, чем версия 11.3.0,
или хотите сохранить устаревшее поведение
системной переменной Строка ячейки Excel.

Use outgoing Email server settings Select this option if your бот contains the
Отправить сообщение эл. почты command. Use
these settings to specify the type of email server
to use.

Include web service settings Select this option for custom proxy configuration
support. When you select this option, the REST
commands with Custom proxy configurations
that use the following global variables are
migrated:
• AAProxyHost for Hostname
• AAProxyPort for Port

Преобразовать боты, созданные с
помощью Internet Explorer, для работы в
Edge в режиме Internet Explorer

Выберите этот параметр, если вы хотите
преобразовать боты Enterprise 10 или
Enterprise 11, которые используют Internet
Explorer, в боты Automation 360, которые
используют Microsoft Edge в режиме IE.

Convert \n characters to \r\n in Log to File
action

Select this option to convert \n characters (LF)
into \r\n characters (CRLF), which automatically
take new line in migrated боты using Log to File
action.

Tag боты and variables for analytics Select this option when Bot Insight data exists
in the Enterprise 11 боты, and you also want to
migrate the Bot Insight data with those боты.
When you select this option, the Bot Insight
Open and Close actions are created.

Note:  To migrate Bot Insight data, you must
enable this option.

When you migrate Bot Insight data along with
бот migration, ensure that the Bot Insight
prerequisites are met.Bot Insight prerequisites |
Cloud Migration Utility prerequisites

If the Bot Insight prerequisites are not met,
Cloud migration with Bot Insight might become
stuck in the In Progress state.
Also, regardless of whether the Bot Insight and
the Cloud Migration utility prerequisites are
met or not, import or upload of the .atmx file
> Migrate. This issue is observed on both On-
Premises and Cloud deployments.

5. Щелкните Вперед.
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6. Выберите боты и папки, содержащие боты (TaskBots и MetaBots), которые требуется перенести.
Возможность выбора папки избавляет от необходимости выбора отдельных боты из этой папки.
• Если вы выбрали папку, все подпапки в этой папке и боты внутри этих подпапок

автоматически выбираются для миграции.
• Если папка пуста, в процессе миграции возникает ошибка.

В столбце Последние перенесенные указано, когда бот был перенесен ранее.
«Неприменимо» означает, что бот ранее не переносился.

7. Щелкните Вперед.
8. Выберите одно или несколько имен пользователей из списка для запуска миграции и щелкните

стрелку вправо.
В именах пользователей могут отображаться либо сообщение Выбирается во время
выполнения или имя устройства в столбце Устройство. Имя устройства указывает на
зарегистрированное устройство данного пользователя. Сообщение Выбирается во время
выполнения отображается, когда у пользователя нет устройства по умолчанию, например,
пользователь не зарегистрировал устройство, а системный администратор назначил устройство
этому пользователю. Устройство по умолчанию должно быть настроено для всех выбранных
вами Bot Runner.
• Боты распределяются между выбранными пользователями Bot Runner с использованием

метода циклического перебора.
• Первый пользователь Bot Runner в выбранном списке используется в первую очередь.
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• Родительский бот и его зависимости назначаются одному пользователю Bot Runner.

9. Щелкните Вперед.
10. Optional: Проанализируйте зависимые TaskBots и MetaBots на странице Бот и зависимые боты

перед их миграцией.
Если выбрана папка и боты на странице Боты, то эта папка и зависимости выбранных боты
отображаются в таблице.
Зависимые боты (TaskBots и MetaBots) переносятся до основного бот.
В таблице основной бот показан внизу, а его зависимости — наверху. Например, следующая
информация означает, что Sample05.atmx зависит от Sample04.atmx, а Sample04.atmx —
от MessageBox.atmx и MetaTask.mbot.

Тип Имя Путь

MetaBot (mbot) MetaTask.mbot Bots\My Metabots
\MetaTask.mbot

TaskBot (atmx) MessageBox.atmx Bots\MyTasks
\MessageBox.atmx

TaskBot (atmx) Sample04.atmx Bots\MyTasks
\Sample04.atmx
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Тип Имя Путь

TaskBot (atmx) Sample05.atmx Bots\MyTasks
\Sample05.atmx

11. Щелкните Перенос ботов.
Система проверяет наличие у пользователя, инициировавшего миграцию, и выбранных
пользователей Bot Runner необходимых разрешений для выполнения миграции. Система
проверяет, все ли перечисленные ниже разрешения предоставлены пользователю,
выполняющему миграцию, и выбранным вами Bot Runner.
• Пользователь, выполняющий миграцию.

• Разрешение Просмотр миграции
• Разрешение Управлять миграцией
• Разрешение на папки, содержащие боты и MetaBots, которые требуется перенести
• A role that has access to Bot Runner that you want to select for running the migration (on the

Administration > Migration > Run As page)
• Разрешение Просмотреть и редактировать ВСЕ значения атрибута учетных

данных

• Bot Runner:
• Необслуживаемая лицензия Bot Runner
• Статус Автоматический вход задан
• Разрешение Разрешить пользователю Bot Runner запустить миграции
• Разрешение Создать стандартные атрибуты для учетных данных
• Разрешение Создать папку
• Разрешение Просмотреть пакет
• Разрешение Зарегистрировать устройство
• Разрешения Просмотреть моих ботов и Запустить моих ботов
• Разрешения Загрузить и Выгрузить для папок My Tasks и My Metabots в Automation

360
• Настройки Устройство по умолчанию

Если какие-либо из требуемых разрешений не предоставлены, система отобразит эти
разрешения в результатах проверки. Вы должны предоставить необходимые разрешения и
снова запустить процесс миграции.
Если все необходимые разрешения предоставлены пользователям, система начинает миграцию
выбранных боты и их зависимых боты.
После миграции система загружает успешно перенесенные боты, связанные данные Bot Insight и
опубликованные информационные панели в общедоступную рабочую область в Automation 360
Control Room (в папку с файлом .atmx). В рабочей области «Общие» хранятся только миграции
бот, инициированные из Control Room.
Сведения об ошибках валидации для каждого бот отображаются в результатах миграции бот.
Сведения об ошибках включают номер строки, сведения об ошибке, причину и рекомендацию.
В результатах переноса Бот отображаются количество перенесенных боты, а также их
индивидуальные статусы. Чтобы отфильтровать боты по определенным статусам для быстрого
анализа, щелкните столбец Статус.
Чтобы просмотреть подробные сведения о причинах ошибки, в столбце Причины щелкните
кнопку Просмотреть проблемы с переносом. В диалоговом окне Просмотр проблем при
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миграции отображается номер строки, в которой произошла ошибка, краткое описание ошибки
и подробный отчет об ошибке для просмотра.
a) Выгрузите бот, чтобы перенести частные информационные панели, связанные с этим бот.

В первый раз частные информационные панели переносятся только для пользователя,
который проверил связанный с ними бот.

b) View in-progress migration activities from the Activity > In progress page.

See the following video on how to migrate Enterprise 11 or Enterprise 10 bots:

Если вы столкнулись с ошибками во время миграции, см. следующие ресурсы:
• Migration error: Physical bot files aren't available (A-People login required)
• Migration error: Unable to download the source bot file for conversion (A-People login required)
• Migration shows unsuccessful by creating duplicate atmx files (A-People login required)
• Unable to migrate due to java.lang.StackOverflowError exception (A-People login required)
• Migration error: Unable to delete the file MigrationBot (A-People login required)

Проверка миграции бот on page 1314 | Просмотр отчетов о переносе данных on page 1315
Related tasks
Просмотр отчетов о переносе данных on page 1315
Используйте отчеты для анализа состояния миграции отдельных бот, миграции данных и миграции
журнала аудита, а также для определения состояния отдельной миграции и сводки по ней.
Экспорт информационных панелей Enterprise 11 Bot Insight для миграции on page 1204
Используйте утилиту предварительной миграции Bot Insight для экспорта метаданных
информационной панели Enterprise 11 Bot Insight (виджеты и макеты) и профиль информационной
панели в ZIP-файле. Запустите эту утилиту на устройстве Enterprise 11 и вставьте ZIP-файл в
репозиторий Automation 360, чтобы перенести информационные панели Bot Insight.
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Как выполняется миграция MetaBots
При выполнении миграции MetaBot на Automation 360 создаются эквивалентные боты для различной
логики, доступной в MetaBot, за исключением экранов приложений. После успешной миграции вся
логика в файле .mbot преобразуется в файл TaskBot.
MetaBot содержит ресурсы и логику. Ресурсы — это экраны приложений или библиотеки DLL,
которые используются для автоматизации задачи в приложении. Логика — это набор команд для
выполнения операции и взаимодействия с другой логикой и боты.

Note:
• Before you migrate .atmx or .mbot using the Bot Migration Wizard, ensure that all the Logics,

dlls, .mbots, .atmx files and other dependencies related to the MetaBots or TaskBots that were
previously migrated are not in the Checked-out state. Otherwise, the following error occurs during re-
migration:
Bot is not ready for migration.

The details of the unsuccessful migration are displayed in the Bot Migration wizard > Results >
Skipped tab.

• If the бот that you are migrating has been checked out or has been migrated previously, ensure that
the бот to be migrated is in the Checked-in state. Also, to reuse the migrated bot, in the Bot Migration
Wizard, select the Overwrite if a bot with same name exists option. To use an updated бот,
disable the Overwrite if a bot with same name exists option.

В процессе миграции выполняются указанные ниже действия.
• Преобразование логики MetaBot в соответствующие TaskBots.
• Сохранение структуры папок MetaBots при переносе. Новые папки, созданные в Automation 360

содержат TaskBots для каждой логики, перенесенной в Automation 360.
• Обновление TaskBots, которые используют логику MetaBot, для обращения к новым TaskBots,

которые создаются для логики перенесенного MetaBot.
Вам не придется обновлять TaskBots вручную.

Такие функции, как использование библиотек DLL, входные и выходные переменные и разрешение
Выполнить, которые были доступны только для MetaBots, теперь доступны для всех TaskBots.

Мы будем использовать указанный ниже MetaBot, чтобы объяснить, как выполняется его миграция в
Automation 360.
• Имя MetaBot. MetaTask
• Ресурсы.

• Экран входа в систему
• General.dll
• DLL\Binary.dll

• Логика:
• Common
• Process1\Connect
• Process1\Disconnect
• Process1\Operations\Numeric
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Преимущества повторного использования TaskBots в Automation 360

В приведенной ниже таблице перечислены преимущества повторного использования TaskBots в
Automation 360 по сравнению с MetaBots в Enterprise 11.

Повторно используемые TaskBots в
Automation 360

MetaBots v11

Можно перейти к дочернему бот с помощью
компонента «Средство поиска», что экономит
время. Перейдите в Редактор > Средство
поиска, чтобы получить доступ к дочернему
бот.

You must navigate through the TaskBot > Run
action to reach the child бот.

Вы можете выполнить поиск дочерних боты
из личной рабочей области, а также из
общедоступной рабочей области, чтобы
использовать их в TaskBots.

Чтобы использовать дочерний бот в TaskBots,
вы должны загрузить MetaBots в локальный
репозиторий.

Развертывается только определенная Логика,
если она используется в задаче, что экономит
время и пропускную способность.

Весь MetaBot развертывается на машине Bot
Runner, даже если в задаче используется
только одна Логика.

Обеспечивается улучшенный RBAC, который
позволяет настраивать разрешения.

MetaBots принудительно назначает всем
Логика одинаковые разрешения, даже если
несколько Логика распределены по разным
папкам.

Процесс миграции MetaBot

Система создает папку с тем же именем, что и MetaBot в рамках папки My MetaBots, доступной в
папке Bots, с сохранением той же структуры папок, что и в Enterprise 11. Например, если структура
папок в Enterprise 11: Accounts/Tax/MetaTask.mbot, то система сохраняет эту структуру папок
как Accounts/Tax/MetaTask.mbot. Все компоненты MetaBot хранятся в папке, созданной для
этого MetaBot. В этом примере система создает папку MetaTask в папке Bots\My MetaBots и
сохраняет все компоненты MetaBot в этой папке.
боты Enterprise 10, которые напрямую вызывают библиотеки DLL и экраны в MetaBot без
использования логики MetaBot, переносятся в эквивалентные TaskBots и actions в Automation 360.
Если в ходе Enterprise 10 библиотека DLL возвращает параметры типа «список» или «массив» и
вывод этой библиотеки DLL сопоставляется с параметром типа «значение», в начале выходного
значения добавляется дополнительный пробел. Дополнительный пробел не добавляется к
выходному значению после выполнения миграции бот.
MetaBots 10.1, которые используют функции DLL, принимающие входные параметры типа
«одномерный массив» и «список», и сопоставляются с параметром типа «массив». В таких случаях
для указания возвращаемого значения в качестве входных данных требуются индекс строки и
индекс столбца. После миграции индекс строки рассматривается как номер столбца.

Note:  Для боты, которые обновлены с 10.1 до 10.3.5 и затем перенесены в Automation 360, Bot
Migration Wizard не показывает зависимость на странице Бот и зависимые боты. Для таких боты
вы должны перенести MetaBots перед тем, как переносить TaskBots, которые вызывают эти MetaBots.
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Миграция библиотек DLL

Система не поддерживает структуру папок для ресурсов, чтобы сохранить зависимости между
библиотеками DLL. Для приведенного выше примера, General.dll и Binary.dll хранятся в папке
MetaTask, хотя Binaary.dll хранится в подпапке DLL.
See the following video for information on migrating MetaBots with DLLs to Automation 360:

MetaBot migration process overview

Use the information provided in this section to understand the processes involved in migrating MetaBot to
Automation 360.

Concept of DLL session in the migrated бот The following DLL changes are observed in the
migrated бот:
• When you migrate a TaskBot with multiple

MetaBots that contain DLLs with the same
name, a session name using the name of the
first DLL is created. When the subsequent DLL
with the same name from another MetaBot is
migrated, the ID of the folder in which the DLL
resides is used as a session name.
For example:M_DLL_Session-
<MetabotFolderId>_<DLLName>.

• When the Execute DLL command in Enterprise
11 is migrated to Automation 360, the command
is converted to the Open and Run function
actions and the Dll Session does not exist If
condition.

• The DLL session name is created by appending
the DLL name to the "M-DLL-Session-" token.
For example, if the DLL name is Sample.dll, after
migration, the DLL session name will be M-DLL-
Session-Sample.

• The DLL session represents the DLL it is using to
run the DLL functions.

• To run multiple functions from the same DLL,
the same DLL session name must be provided in
the Session name field.

Condition to check for the existence of a DLL
session in a migrated бот

After migration, when the same DLL is used across
multiple logics of the same MetaBot, a condition
to check if a DLL session is already open is added
for every DLL to ensure that the DLL session is
opened only once. Some DLLs that are used in
MetaBot share sessions or global variables across
multiple DLL functions. If such DLL functions are
called from different logics, sharing of such sessions
and variables is possible only if the DLL session
is opened only once and a condition is added to
check if a DLL session is already available. If a DLL
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session is missing, Automation 360 creates a DLL
session of type Global.

What happens to a migrated TaskBot that has
reference to two DLL functions from same or
different logics of a MetaBot?

In Enterprise 11, if a TaskBot was referencing to a
logic that called two functions using the Run Logic
command, in Automation 360, a DLL session will
be created in the TaskBot (logics are migrated as
TaskBots) and will be used in the Run function
action. Also, when a TaskBot refers multiple logics
that calls multiple functions, the TaskBots will
use the same DLL session name to execute the
functions. The DLL session condition check will
ensure that only one session is created across such
logics.
For example, if a TaskBot is using MetaBot1 Logic
and MetaBot2 Logic where MetaBot1 Logic and
MetaBot2 Logic are calling multiple functions, when
you run the Taskbot, a DLL session name is created
to run MetaBot1 Logic. The DLL session name that
was created to run MetaBot1 Logic will be used to
run MetaBot2 Logic as well.

Миграция экранов

Каждый экран в MetaBot преобразуется в переменную окна, и actions, выполняемые на экране,
переносятся в эквивалентные actions в Automation 360.
В приведенной ниже таблице перечислены экраны, которые можно перенести в Automation 360.

Браузер Internet Explorer
Google Chrome (только для типа
воспроизведения объекта)

Тип экрана Стандартная

Technology Java, HTML, MSAA, .Net, автоматизация
пользовательского интерфейса (только для
типа воспроизведение объекта)

Тип воспроизведения Объект, изображение, координата

Вы также можете перенести MetaBots с экранами, снимки которых записываются в окружении Citrix
из приложений, основанных на технологиях Java, UI Automation и MSAA.
Связанные объекты на экране MetaBot, снимки которых записаны с помощью типа воспроизведения
объекта, переносятся в action Запись в Средство записи пакет. Исходный объект отображается на
вкладке Основная, а связанный объект отображается на вкладке Привязка действия Запись.
В приведенной ниже таблице представлена информация о действиях, которые выполняются над
объектом типа воспроизведения объекта и связанным объектом типа воспроизведения текста,
доступным на экране, которые переносятся в эквивалентные действия в Automation 360:
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Тип
воспроизведения

Действие Enterprise 11 Действие Automation 360

Объект Получить свойство,
Получить общее число
элементов, Получить
выбранный индекс,
Получить выбранный
текст, Выбрать элемент
по тексту, Выбрать
элемент по индексу,
Щелчок, Левый щелчок,
Правый щелчок, Двойной
щелчок, Установить текст,
Добавить текст, Получить
свойство, Установить,
Снять, Переключить,
Развернуть, Выбрать,
Получить состояние,

Миграция в action Запись Средство записи
пакет.
Команды GetAllChidrenName и
GetAllChidrenValue в Enterprise 11/Enterprise
10 возвращают значения переменных
строкового типа. В Automation 360 они
возвращают значения списка. Процесс миграции
объединяет значения списка и сохраняет их
в строковой переменной для поддержания
согласованного поведения бот в разных
выпусках.
Команда Клонирование объектов с
действием Экспорт в CSV в Enterprise
11/Enterprise 10 переносится в:
• action Запись в Средство записи пакет.

Это action сохраняет записанную дату в
переменной таблицы.

• action Записать в файл в Таблица данных
пакет.
Это action сохраняет данные из переменной
таблицы в файл CSV.

В приведенной ниже таблице представлена информация о действиях, которые выполняются
над объектом типа воспроизведения изображения связанный объект типа воспроизведения
изображения, доступным на экране, и переносятся в эквивалентные действия в Automation 360:

Тип
воспроизведения

Действие Enterprise 11 Действие Automation 360

Левый щелчок Перенос в action Поиск окна в окне в
Распознавание изображений пакет с помощью
Левого щелчка при выборе из списка
Действие.

Правый щелчок Перенос в action Поиск окна в окне в
Распознавание изображений пакет с помощью
Правого щелчка при выборе из списка
Действие.

Двойной щелчок Перенос в action Поиск окна в окне в пакет
Распознавание изображений с помощью
Двойного щелчка при выборе из списка
Действие.

Изображение

Щелчок средней кнопкой
мыши

Перенос в action Поиск окна в окне в
Распознавание изображений пакет с помощью
Левого щелчка при выборе из списка
Действие.
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Тип
воспроизведения

Действие Enterprise 11 Действие Automation 360

Установить текст Перенос в:
• action Поиск окна в окне в Распознавание

изображений пакет с помощью Левого
щелчка при выборе из списка Действие.

• action Задержка в Задержка пакет с
Регулярной задержкой, для которой
установлено значение 500 миллисекунд.

• action Имитация нажатия клавиш в
Имитация нажатия клавиш пакет.

Получить текст Перенос в action Захватить область в
Распознавание текста (OCR) пакет.

GetVisibility Перенос в действие ЕСЛИ с условием
Распознавание изображений:Найти окно
в окне. Действие GetVisibility возвращает
значение True или False в зависимости от того,
отображается ли объект на изображении или
нет. Аналогично, условие в действии ЕСЛИ
оценивается в зависимости от того, находится
ли окно в другом окне. Результат сохраняется во
временной переменной.

В приведенной ниже таблице представлена информация о действиях, которые выполняются над
объектом типа воспроизведения координаты связанный объект типа воспроизведения координаты,
доступным на экране, и переносятся на эквивалентные действия в Automation 360:

Тип
воспроизведения

Действие Enterprise 11 Действие Automation 360

Щелчок Перенос в action Щелчок в Мышь пакет с
выбранными параметрами Левая кнопка и
Щелчок.

Левый щелчок Перенос в action Щелчок в Мышь пакет с
выбранными параметрами Левая кнопка и
Щелчок.

Правый щелчок Перенос в action Щелчок в Мышь пакет с
выбранными параметрами Правая кнопка и
Щелчок.

Щелчок средней кнопкой
мыши

Перенос в action Щелчок в Мышь пакет с
выбранными параметрами Средняя кнопка и
Щелчок.

Координата

Двойной щелчок Перенос в action Щелчок в Мышь пакет с
выбранными параметрами Левая кнопка и
Двойной щелчок.
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Тип
воспроизведения

Действие Enterprise 11 Действие Automation 360

Установить текст Перенос в:
• action Щелчок в Мышь пакет с выбранными

параметрами Левая кнопка и Щелчок.
• action Задержка в Задержка пакет с

Регулярной задержкой, для которой
установлено значение 500 миллисекунд.

• action Имитация нажатия клавиш в
Имитация нажатия клавиш пакет.

Получить текст Перенос в:
• action Щелчок в Мышь пакет с выбранными

параметрами Левая кнопка и Щелчок.
• action Очистить в Буфер обмена пакет.
• action Задержка в Задержка пакет с

Регулярной задержкой, для которой
установлено значение 500 миллисекунд.

• action Имитация нажатия клавиш в
Имитация нажатия клавиш пакет.

• action Задержка в Задержка пакет с
Регулярной задержкой, для которой
установлено значение 500 миллисекунд.

• action Копировать в в Буфер обмена пакет.

В приведенной ниже таблице представлена информация о действиях, которые выполняются над
пользовательским объектом типа воспроизведения координаты, доступным на экране, который
переносится в эквивалентные действия в Automation 360:

Тип
воспроизведения

Действие
Enterprise 11

Действие Automation 360

Щелчок Перенос в action Щелчок в Мышь пакет с выбранными
параметрами Левая кнопка и Щелчок.

Левый щелчок Перенос в action Щелчок в Мышь пакет с выбранными
параметрами Левая кнопка и Щелчок.

Щелчок средней
кнопкой мыши

Перенос в action Щелчок в Мышь пакет с выбранными
параметрами Средняя кнопка и Щелчок.

Двойной щелчок Перенос в action Щелчок в Мышь пакет с выбранными
параметрами Левая кнопка и Двойной щелчок.

Координата

Установить текст Перенос в следующее:
• action Щелчок в Мышь пакет с выбранными

параметрами Левая кнопка и Щелчок.
• action Задержка в Задержка пакет с Регулярной

задержкой, для которой установлено значение
500 миллисекунд.

• action Имитация нажатия клавиш в Имитация
нажатия клавиш пакет.
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Тип
воспроизведения

Действие
Enterprise 11

Действие Automation 360

Получить текст Перенос в следующее:
• action Щелчок в Мышь пакет с выбранными

параметрами Левая кнопка и Щелчок.
• action Очистить в Буфер обмена пакет.
• action Задержка в Задержка пакет с Регулярной

задержкой, для которой установлено значение
500 миллисекунд.

• action Имитация нажатия клавиш в Имитация
нажатия клавиш пакет.

• action Задержка в Задержка пакет с Регулярной
задержкой, для которой установлено значение
500 миллисекунд.

• action Копировать в в Буфер обмена пакет.

В приведенной ниже таблице представлена информация о действиях, которые выполняются
над пользовательским объектом типа воспроизведения текста, доступным на экране, который
переносится в эквивалентные действия в Automation 360:

Тип
воспроизведения

Действие
Enterprise 11

Действие Automation 360

Щелчок Перенос в action Поиск окна в окне в Распознавание
изображений пакет с помощью Левого щелчка при
выборе из списка Действие.

Левый щелчок Перенос в action Поиск окна в окне в Распознавание
изображений пакет с помощью Левого щелчка при
выборе из списка Действие.

Двойной щелчок Перенос в action Поиск окна в окне в Распознавание
изображений пакет с помощью Двойного щелчка при
выборе из списка Действие.

Установить текст Перенос в следующее:
• action Поиск окна в окне в Распознавание

изображений пакет с помощью Левого щелчка при
выборе из списка Действие.

• action Задержка в Задержка пакет с Регулярной
задержкой, для которой установлено значение
500 миллисекунд.

• action Имитация нажатия клавиш в Имитация
нажатия клавиш пакет.

Текст

Получить текст Перенос в action Захватить область в Распознавание
текста (OCR) пакет.
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Миграция логики

Каждая логика в MetaBot преобразуется в TaskBot, а каждая команда, используемая в логике,
преобразуется в эквивалентное действие в Automation 360. Переменная, используемая в логике,
преобразуется в эквивалентную переменную в Automation 360. Переменные компонента учетных
данных, используемые в логике, переносятся в Automation 360 и используются в эквивалентных
действиях в перенесенных боты. Если Тип параметра переменной — вход или выход, то он
сохраняется и после переноса этой переменной в Automation 360. Например, если для Типа
параметра переменной ABC установлено значение Вход, то переменная ABC, созданная в
Automation 360, имеет выбранный параметр Использовать как вход после миграции. Система
сохраняет внутреннюю структуру папок логики. Для приведенного выше примера вся перенесенная
логика хранится так, как указано в приведенной ниже таблице.

Структура папок в Automation 360 Запись

MetaTask Общий

MetaTask\Process1 Подключить

MetaTask\Process1 Отключить

MetaTask\Process1\Operations Числовой

В приведенной ниже таблице представлена информация о том, как команда Import DataSet,
используемая в логике MetaBot, переносится в эквивалентные действия в Automation 360:

Тип
воспроизведения

Действие Enterprise 11 Действие Automation 360

Объект Получить свойство,
Получить общее число
элементов, Получить
выбранный индекс,
Получить выбранный
текст, Выбрать элемент по
тексту, Выбрать элемент
по индексу, Щелчок,
Левый щелчок, Правый
щелчок, Двойной щелчок

Миграция в action Запись Средство записи
пакет.

Левый щелчок Перенос в action Поиск окна в окне в
Распознавание изображений пакет с помощью
Левого щелчка при выборе из списка
Действие.

Правый щелчок Перенос в action Поиск окна в окне в
Распознавание изображений пакет с помощью
Правого щелчка при выборе из списка
Действие.

Изображение

Двойной щелчок Перенос в action Поиск окна в окне в пакет
Распознавание изображений с помощью
Двойного щелчка при выборе из списка
Действие.
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Тип
воспроизведения

Действие Enterprise 11 Действие Automation 360

Щелчок средней кнопкой
мыши

Перенос в action Поиск окна в окне в
Распознавание изображений пакет с помощью
Левого щелчка при выборе из списка
Действие.

Установить текст Перенос в:
• action Поиск окна в окне в Распознавание

изображений пакет с помощью Левого
щелчка при выборе из списка Действие.

• action Задержка в Задержка пакет с
Регулярной задержкой, для которой
установлено значение 500 миллисекунд.

• action Имитация нажатия клавиш в
Имитация нажатия клавиш пакет.

Щелчок Перенос в action Щелчок в Мышь пакет с
выбранными параметрами Левая кнопка и
Щелчок.

Левый щелчок Перенос в action Щелчок в Мышь пакет с
выбранными параметрами Левая кнопка и
Щелчок.

Щелчок средней кнопкой
мыши

Перенос в action Щелчок в Мышь пакет с
выбранными параметрами Средняя кнопка и
Щелчок.

Двойной щелчок Перенос в action Щелчок в Мышь пакет с
выбранными параметрами Левая кнопка и
Двойной щелчок.

Координата

Установить текст Перенос в:
• action Щелчок в Мышь пакет с выбранными

параметрами Левая кнопка и Щелчок.
• action Задержка в Задержка пакет с

Регулярной задержкой, для которой
установлено значение 500 миллисекунд.

• action Имитация нажатия клавиш в
Имитация нажатия клавиш пакет.

В приведенной ниже таблице представлена информация о том, как команда Export Dataset,
используемая в логике MetaBot, переносится в эквивалентные действия в Automation 360:
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Тип
воспроизведения

Действие Enterprise 11 Действие Automation 360

Объект Получить свойство,
Получить общее число
элементов, Получить
выбранный индекс,
Получить выбранный
текст, Выбрать элемент по
тексту, Выбрать элемент
по индексу, Щелчок,
Левый щелчок, Правый
щелчок, Двойной щелчок

Миграция в action Запись Средство записи
пакет.

Левый щелчок Перенос в action Поиск окна в окне в
Распознавание изображений пакет с помощью
Левого щелчка при выборе из списка
Действие.

Правый щелчок Перенос в action Поиск окна в окне в
Распознавание изображений пакет с помощью
Правого щелчка при выборе из списка
Действие.

Двойной щелчок Перенос в action Поиск окна в окне в пакет
Распознавание изображений с помощью
Двойного щелчка при выборе из списка
Действие.

Щелчок средней кнопкой
мыши

Перенос в action Поиск окна в окне в
Распознавание изображений пакет с помощью
Левого щелчка при выборе из списка
Действие.

Изображение

Получить текст Перенос в action Захватить область в
Распознавание текста (OCR) пакет.

Щелчок Перенос в action Щелчок в Мышь пакет с
выбранными параметрами Левая кнопка и
Щелчок.

Левый щелчок Перенос в action Щелчок в Мышь пакет с
выбранными параметрами Левая кнопка и
Щелчок.

Щелчок средней кнопкой
мыши

Перенос в action Щелчок в Мышь пакет с
выбранными параметрами Средняя кнопка и
Щелчок.

Координата

Двойной щелчок Перенос в action Щелчок в Мышь пакет с
выбранными параметрами Левая кнопка и
Двойной щелчок.
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Тип
воспроизведения

Действие Enterprise 11 Действие Automation 360

Получить текст Перенос в:
• action Щелчок в Мышь пакет с выбранными

параметрами Левая кнопка и Щелчок.
• action Очистить в Буфер обмена пакет.
• action Задержка в Задержка пакет с

Регулярной задержкой, для которой
установлено значение 500 миллисекунд.

• action Имитация нажатия клавиш в
Имитация нажатия клавиш пакет.

• action Задержка в Задержка пакет с
Регулярной задержкой, для которой
установлено значение 500 миллисекунд.

• action Копировать в в Буфер обмена пакет.

Миграция команды Run Logic (Запустить логику)

Команда Запустить логику используется в бот для запуска определенной логики из MetaBot в
Enterprise 11. Когда вы переносите этот бот, то команда Запустить логику команда преобразуется
в действие Запустить TaskBot пакет.
Входные переменные преобразуются в эквивалентные переменные в Automation 360 а выходные
переменные переносятся в переменную словаря. В переменной словаря нужно использовать ключ,
чтобы использовать связанное с ним значение. Переменная словаря может содержать другие типы
переменных, например, «список», «значение», «целое число» и «массив». Вы можете сопоставить
переменные, доступные в переменной словаря, с другими типами переменных. Например, вы
можете сопоставить переменную типа «список», доступную в переменной словаря, с переменными
типа «список», «значение» и «массив».

Миграция команды «Выполнить»

Библиотеки DLL в MetaBots используют команду Выполнить для запуска функции из этой
библиотеки DLL. После миграции в Automation 360 каждая команда Выполнить преобразуется в
действия Открыть, Выполнить функцию и Закрыть в пакете DLL. Информация о том, какую
функцию запускать из библиотеки DLL, какие параметры использовать, и другие подробности в
команде Выполнить переносятся в команду Запустить.
Начиная с Enterprise A2019.16 (6448), вы можете перенести MetaBots, которые содержат библиотеки
DLL, типы возврата которых отличаются от типов возврата библиотек MetaBot. В приведенной
ниже таблице представлена информация о типе переменной на выходе MetaBot и тип возврата
библиотеки DLL.

Тип переменной MetaBot Тип возврата функции DLL

Значение Двумерный массив, Список, Байт в массиве
(Byte[]), беззнаковые целые числа (UInt32,
UInt64), целые числа со знаком, IDictionary,
IList и беззнаковые целые числа в массиве
(UInt16[], UInt32[], UInt64[]), байт со знаком
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Тип переменной MetaBot Тип возврата функции DLL

Массив Двумерный массив, Список, беззнаковые
целые числа (UInt16[], UInt32, UInt64), целые
числа со знаком, IList, байт со знаком и
IDictionary

Note:  Миграция боты, которая использует переменную IDictionay, поддерживается, однако,
перенесенные боты могут не возвращать правильное значение. Это поведение аналогично
поведению в Enterprise 11 или Enterprise 10.

В приведенной ниже таблице представлена информация о типе переменной, которая передается из
MetaBot, и тип входных данных, которые принимает библиотека DLL.

Тип переменной MetaBot Тип входной переменной, которую
принимает библиотека DLL

Список Двумерный массив, список, байт, беззнаковые
целые числа (UInt16, UInt32, UInt64), целые
числа со знаком, байт со знаком, байт в
массиве (Byte[]) и беззнаковые целые числа в
массиве (UInt16[], UInt32[], UInt64[])

Массив Двумерный массив, список, байт, беззнаковые
целые числа (UInt16, UInt32, UInt64), целые
числа со знаком, байт со знаком, байт в
массиве (Byte[]) и беззнаковые целые числа в
массиве (UInt16[], UInt32[], UInt64[])

Значение Байт, беззнаковые целые числа (UInt16,
UInt32, UInt64), целые числа со знаком, байт
со знаком

Словарь Байт, беззнаковые целые числа (UInt16,
UInt32, UInt64), целые числа со знаком, байт
со знаком

Процедура миграции переменной AAApplicationPath
Переменная AAApplicationPath используется в Enterprise 11 и Enterprise 10 для указания
физического пути к бот или файлу, который используется в текущем бот. Системная переменная
AAApplicationPath возвращает путь, заданный в разделе Инструмент > Параметр так называемого
“клиентского приложения”.

Миграция из Enterprise 11 с помощью восстановленной базы данных
Enterprise 11

При миграции в Automation 360 с использованием восстановленной базы данных Enterprise 11
выполняются указанные ниже действия.
• Создается глобальное значение AAApplicationPath, когда первый бот переносится с помощью Bot

Migration Wizard.
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• Копируется значение системной переменной AAApplicationPath, указанное для каждого
пользователя в Enterprise 11 и устанавливается как глобальное значение AAApplicationPath для
всех этих пользователей в Automation 360.

• Обновляются ссылки, которые были использованы в боты Enterprise 11 с глобальным значением
AAApplicationPath, доступным в Control Room Automation 360, что позволяет не обновлять
перенесенные боты для использования AAApplicationPath.

• Обновляется путь в наборе команд Выполнить задачу в бот Enterprise 11. Например, если в
Enterprise 11 путем в команде Выполнить задачу выбран $AAApplicationPath$\Automation
 Anywhere\My Tasks\child-task.atmx, он автоматически преобразуется в Bots\My Tasks
\child-task.atmx after migration.
Таким образом, ручное обновление не требуется, после миграции бот работает должным
образом.

Important:  При миграции боты с помощью пакет миграции Бот необходимо вручную создать
глобальное значение AAApplicationPath. После создания глобального значения AAApplicationPath
все пользователи, которые использовали системную переменную AAApplicationPath в Enterprise
11, должны заменить глобальное значение AAApplicationPath значением, которое используется в
Enterprise 11.
См. Миграция из Enterprise 11 с помощью восстановленной базы данных Enterprise 11.

Миграция из Enterprise 10

При миграции из Enterprise 10 необходимо вручную создать глобальное значение
AAApplicationPath в Automation 360 с выбранным параметром МОЖЕТ быть изменено. После
создания глобального значения AAApplicationPath все пользователи, которые использовали
системную переменную AAApplicationPath в Enterprise 10, должны заменить глобальное значение
AAApplicationPath значением, которое используется в Enterprise 10. Это обновление гарантирует,
что при запуске бот в Automation 360 значение папки AAApplicationPath будет уникальным для
каждого пользователя.
Пример. Если значение пути Enterprise 10 для AAApplicationPath — D:\John.Doe\My
 Documents\Automation Anywhere Files, необходимо создать глобальное значение
AAApplicationPath в Automation 360 и обновить с помощью этого пути.

Note:  Bot Runner и Bot Creator должны обновить глобальное значение для AAApplicationPath в
Control Room перед запуском перенесенных боты в Automation 360.

См. раздел Подготовка к миграции с Enterprise 10 в Automation 360 On-Premises on page 1213.

Ручная миграция из Enterprise 11 или Enterprise 10

При ручной миграции из Enterprise 11 или Enterprise 10, необходимо вручную создать глобальное
значение AAApplicationPath в Automation 360 с выбранным параметром МОЖЕТ быть изменено.
После создания глобального значения AAApplicationPath все пользователи, которые использовали
системную переменную AAApplicationPath в Enterprise 11 или Enterprise 10, должны заменить
глобальное значение AAApplicationPath значением, которое используется в Enterprise 11 или
Enterprise 10.
См. раздел Предварительные условия для миграции вручную on page 1197.
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AASettings supported in Automation 360
Review the configurations supported in the AASettings file for the Control Room.
After migration, you can configure the AASettings that are supported in Automation 360.

Ключ Описание Values allowed Значение по
умолчанию

Supported in
Automation 360

allowaddingdefaultnamespaceAllows you
to enable
DefaultNSPrefix.
In the XML
package, when
you insert a node
into the XML file,
DefaultNSPrefix is
no longer added.
In the Advanced
view tab of the
insert a node
action, xmlns
(the default XML
namespace) is not
allowed either as
a prefix or as an
attribute.

Note:  If
DefaultNSPrefix
is enabled and
the value of
allowaddingdefaultnamespace
is set to True,
when you insert
or update a new
node as an empty
node, a newline
character will
be added and
indentation will be
lost.

True, False False Нет

allowlowersecurityciphersslconnectionformainframeAllows you
to lower the
security cipher
for connecting
to mainframe
hosts that use SSL
connections with
lower security
cipher.

True, False False Нет
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Ключ Описание Values allowed Значение по
умолчанию

Supported in
Automation 360

applyshiftkeyfix Allows you to
check for any
missing special
key in child боты
and executes the
key if the special
key is missing.

0, 1 0 Нет

capturehtmlwithjs Allows you to
enable capturing
HTML by MetaBot
screen capture.

True, False True Нет

citrixchanneltimeoutAllows you to set
the Citrix channel
timeout value for
the Citrix remote
agent.

Целое число -- Нет

closebrowserbyhandleAllows you
to enable
CloseIEInstanceByhandle
if
CloseIEInstanceByprocess
fails.

0, 1 0 Нет

connectionretryattemptsAllows you
to configure
the number of
attempts to try
for connecting to
the mainframe if
connection to the
mainframe failed.

Целое число 3 Нет

connectionretryintervalAllows you to
configure the
timeout value,
in milliseconds,
to wait before
attempting the
next connection.

Целое число 3000 Нет

connectiontimeout Allows you to
configure the
timeout value,
in minutes,
for database
connections. We
recommend that
you configure this
timeout value to
30 minutes.

Целое число 30 Нет

© 2023 Automation Anywhere. All rights reserved.     1249



    Automation Anywhere - Миграция в Automation 360

Ключ Описание Values allowed Значение по
умолчанию

Supported in
Automation 360

CustomDateFormat Allows you to set
a custom date
format.

String (mm/dd/
yyyy HH:mm:ss)

-- Нет

DecimalPlaces Allows you to
configure the
number of decimal
places for digits
used in the Число
element.

Integer from 0 to
16

4 Нет

enablesetfocusapi Allows you
to configure
the SetFocus
API for Oracle
applications.

True, False False Нет

fetchemailretrycountAllows you to
configure the
number of retries
for fetching
emails.

Целое число 3 Нет

findiewndattmpt Allows you to
use the MetaBot
recorder to search
for objects.

Целое число 5 Нет

ietimeoutvalue Allows you to
configure the
timeout value for
capturing MetaBot
screens.

Целое число 240 Нет

IETimeoutValue Allows you to
configure the
maximum timeout
value, in seconds,
for loading a
webpage on
Internet Explorer.

Целое число 240 Нет

IsEnabled Allows you to
check whether
the decimal places
option in the
Число element
is enabled or
disabled.

True, False False Нет

isremoteobjectdetectionenabledAllows you to
enable automation
of Citrix XenApp
through the
Enterprise Client.

True, False False Нет
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Ключ Описание Values allowed Значение по
умолчанию

Supported in
Automation 360

iterationtoverify  Allows you to
configure the
number of retries
to verify a value in
a cell.

Целое число 3 Нет

keystrokedelay Allows you to
configure a delay
between the up
and down keys in
an Excel table.

Целое число 25 Нет

legacybehaviourforcommaAllows you to
retain the legacy
behavior for the
comma sign.

True, False True Нет

multithreadlogic Allows you to
enable or disable
multithreading.

0, 1 1 Нет

NormalizationForm Allows you
to verify
whether string
normalization is
available.

NFC, NFD, NFKC,
NFKD

-- Нет

ParallelThreadCountAllows you to
configure the
number of links
that can be
processed at a
time.

Целое число 10 Нет

perchardelay Allows you to
configure the
delay between
entering two
characters as
input.

Целое число 0 Нет

percommanddelay Allows you to
configure the
delay between
running keystroke
commands.

Целое число 0 Нет

readvirtualproperty Allows you
to enable the
GetvirtualAccessibleName
API.

True, False True Нет

readwithsystemencodingAllows you to
configure the
default encoding
for the system.

True, False True Нет
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Ключ Описание Values allowed Значение по
умолчанию

Supported in
Automation 360

restclienttype Allows you
to execute
Веб-служба
REST.

restsharpclient,
nativerestclient

restsharpclient Нет

retainexcelcellrowlegacybehaviorAllows you
to revert the
behavior of
ExcelCellRow to
Enterprise 11
version 11.3.1 or
earlier.

True, False False Нет

screenchangewaittimeAllows you to
configure the
timeout value,
in milliseconds,
to wait for the
application after
sending certain
keys because
the screen might
change after
sending some
keys.

Целое число 5 Нет

searchinmultiplewindowAllows you to
check for windows
with the same
name.

0, 1 0 Нет

ShutDownTimeout Allows you to
configure the
timeout value for
the Shutdown
action in the
System пакет.

Целое число 30000 Нет

skipappnames Allows you to
check whether
the application is
Oracle.

Comma-separated
application
starting name.
For example, if
the application
window
title is Test
Application,
then it should
contain the
following value:
Test,abc,xyz

-- Нет

© 2023 Automation Anywhere. All rights reserved.     1252



    Automation Anywhere - Миграция в Automation 360

Ключ Описание Values allowed Значение по
умолчанию

Supported in
Automation 360

textplayirpercentageAllows you to
configure the
match percentage
of the image
recognition based
control finding
in the legacy
AISense Recorder.

Integer from 0 to
100

95 Нет

timeout Allows you to
configure the
HTTP request
timeout value for
the Веб-служба
REST command.

Строка 60000 Нет

Timeout Allows you to
configure the
timeout value
for each web
response while
traversing through
webpages.

Целое число 10 Нет

usesinglethreading Allows you to
enable or disable
single threading.

True, False True Нет

версия Allows you to
select multiple
versions of
keystroke
commands in
Enterprise 11.

Целое число 1 Нет

WaitForPageLoad Allows you
to configure
additional delay
for loading
webpages in
MetaBot and
Средство записи.

0, 1 0 Нет

WaitForWindow Allows you to
configure the wait
time for window.

Целое число 30 Нет

WaitForWindowCheckAllows you to
check whether
the wait time
for window is
enabled.

0, 1 0 Нет

windowactivationmodeAllows you to
activate Окно
using a None key.

0, 1, 2 0 Нет
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Ключ Описание Values allowed Значение по
умолчанию

Supported in
Automation 360

windowresize Allows you to
disable the
resizing of window
during execution.

True, False True Нет

Включение расписаний после миграции
Когда вы копируете данные Enterprise 10 в Automation 360, выполняется миграция расписаний
Enterprise 10. Миграция расписаний версии Enterprise 11 выполняется при обновлении данных
Enterprise 11 до Automation 360.
После миграции бот, связанного с расписанием, система автоматически заменяет файл .atmx бот в
этом расписании на бот Automation 360. Перенесенные расписания неактивны и не имеют связанных
с ними устройств, поэтому некоторые зависимости необходимо повторно сопоставить в среде
Automation 360.
Чтобы снова включить перенесенные расписания, выполните следующие действия.
1. Подтвердите, что бот, связанный с расписанием, успешно перенесен.

Перенесенные расписания указывают только на успешно перенесенные боты. Если миграция бот
не удалась, то связанное расписание продолжает указывать на файл .atmx бот.

2. Установите Bot Agent на ваши устройства Bot Runner.
Установка Bot Agent и регистрация устройств on page 1046

3. Отредактируйте расписание, чтобы добавить соответствующие устройства.
Планирование бот on page 2631

4. Включите расписание, щелкнув Включить после того, как вы предоставите необходимую
информацию для расписания бот.
Планирование бот on page 2631

Related concepts
Миграция в Automation 360 on page 1133
Related tasks
Копирование данных Enterprise 10 on page 1217
Необходимо скопировать данные Enterprise 10 в Automation 360 перед преобразованием боты
Enterprise 10.
Копирование информации Enterprise 11 и ее вставка в Automation 360 on page 1200
Для среды Automation 360 необходимы файлы репозитория сервера Enterprise 11 и файл Credential
Vault. Наиболее эффективным способом получения этих данных является их копирование из среды
Enterprise 11 в Automation 360.
Миграция корпоративных боты on page 1227
The бот migration process uses the Bot Migration Wizard to convert Enterprise 11 or Enterprise 10 боты
(TaskBots and MetaBots) in .atmx and .mbot format to the .bot format used in Automation 360 and
uploads the successfully migrated боты to the Control Room public workspace.

Приостановка и возобновление миграции бот
Вы можете приостановить, а затем возобновить приостановленную миграцию бот. Можно
приостановить миграцию бот, если вы хотите выполнить задачу с высоким приоритетом на том же
устройстве Bot Runner, на котором выполняется миграция бот.

© 2023 Automation Anywhere. All rights reserved.     1254



    Automation Anywhere - Миграция в Automation 360

У вас должны быть необходимые разрешения, чтобы начать миграцию бот.
• Приостановите и возобновите миграцию бот, когда только один Bot Runner используется для

преобразования бот:
a) Выберите активную миграцию бот, которую вы хотите приостановить, на странице Действия

> В процессе выполнения.
b) Щелкните значок приостановки в бот Launcher или на странице В процессе выполнения.

Система приостановит миграцию бот. Состояние миграции бот указано на следующих
страницах:
• На странице Действия > В процессе выполнения и отмечено как «Приостановлено».
• Миграция бот на странице Администрирование > Миграции, где состояние отмечено

как «Приостановлено».
• На вкладке Отчет о миграции ботов, где состояние преобразуемого бот и

приостановленной миграции бот отмечено как «Приостановлено». Состояние всех
остальных боты, которые не были преобразованы, — «В ожидании».

c) Выберите приостановленную миграцию бот, которую вы хотите возобновить, на странице
Действия > В процессе выполнения.

d) Щелкните значок возобновления в бот Launcher или на странице В процессе выполнения.
Система возобновит приостановленную миграцию бот. Подробную информацию о состоянии
возобновленной миграции бот можно найти на следующих страницах:
• На странице Действия > В процессе выполнения, на которой состояние отмечено как

«Активно».
• На странице Администрирование > Миграции, на которой состояние отмечено как «В

процессе выполнения».
• На вкладке Отчет о миграции ботов, где состояние преобразуемого бот и

приостановленной миграции бот отмечено как «В процессе выполнения».

• Приостановите и возобновите миграцию бот на некоторых Bot Runner, когда несколько Bot
Runner используются для преобразования бот:
a) Выберите активную миграцию бот, которую вы хотите приостановить, на странице Действия

> В процессе выполнения.
b) Щелкните значок приостановки на панели инструментов, чтобы приостановить выбранные

процессы миграции.
Система приостанавливает выбранные процессы миграции, которые запущены на различных
Bot Runner. Состояние приостановленной миграции бот отображается на странице Действия
> В процессе выполнения и отмечено как «Приостановлено».
Состояние миграции бот на странице Администрирование > Миграции и на вкладке
Отчет о миграции ботов не изменено.

c) Выберите приостановленные миграции бот, которые вы хотите возобновить, на странице
Действия > В процессе выполнения.

d) Щелкните значок возобновления на панели инструментов, чтобы возобновить выбранные
приостановленные миграции бот.
Система возобновит миграцию бот для выбранных Bot Runner. Состояние Bot Runner, для
которых возобновлена миграция бот, отображается на странице Действия > В процессе
выполнения и отмечено как «Активно».
Состояние миграции бот на странице Администрирование > Миграции отмечено как «В
процессе выполнения».
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• Приостановите миграцию бот для всех Bot Runner, когда несколько Bot Runner используются для
преобразования бот.
a) Выберите все активные миграции бот, которые вы хотите приостановить, на странице

Действия > В процессе выполнения.
b) Щелкните значок приостановки на панели инструментов, чтобы приостановить выбранные

миграции бот.
Система приостанавливает выбранные миграции бот, которые запущены на различных
Bot Runner. Запись всех приостановленных процессов миграции доступна на следующей
странице:
• На странице Действия > В процессе выполнения и отмечено как «Приостановлено».
• На странице Администрирование > Миграции и отмечено как «Приостановлено».
• На вкладке Отчет о миграции ботов, где состояние боты, для которых миграция не

началась, отмечено как «Приостановлено».

c) Выберите все приостановленные миграции бот, которые вы хотите возобновить, на странице
Действия > В процессе выполнения.

d) Щелкните значок возобновления в бот Launcher или на странице В процессе выполнения
для всех Bot Runner.
Система возобновит приостановленную миграцию бот. Состояние для всех Bot Runner
доступно на следующих страницах:
• На странице Действия > В процессе выполнения и отмечено как «Активно».
• На странице Администрирование > Миграции и отмечено как «В процессе

выполнения».
• На вкладке Отчет о миграции ботов, где состояние преобразуемого бот и

приостановленной миграции бот отмечено как «В процессе выполнения».

Остановка миграции бот
Вы можете остановить текущую миграцию бот, если процесс миграции бот не продвигается или не
отвечает.
У вас должны быть необходимые разрешения, чтобы начать миграцию бот.
1. Выберите активную миграцию бот, которую вы хотите остановить, на странице Действия > В

процессе выполнения.
2. Щелкните значок остановки бот Launcher или на странице В процессе выполнения.

Система немедленно завершит миграцию бот. Состояние остановленной миграции бот указано
на следующих страницах:
• На странице Действия > История; отмечено как «Неуспешно».
• На странице Администрирование > Миграции; отмечено как «Неудачно».
• На вкладке Отчет о миграции ботов, где состояние преобразуемого бот и остановленного

процесса миграции отмечено как «Неудачно». Состояние всех остальных боты, которые не
были преобразованы, — «В ожидании».

• На странице Просмотреть историю действий для каждой записи приведена причина сбоя.

© 2023 Automation Anywhere. All rights reserved.     1256



    Automation Anywhere - Миграция в Automation 360

Проверка и обновление боты после миграции
Перенесенные боты загружаются в общий репозиторий Automation 360 Control Room (в ту же папку,
где находятся эквивалентные файлы .atmx). Текущее состояние перенесенных боты и любые
ошибки из-за неподдерживаемых команд или атрибутов, доступных в этих боты, можно просмотреть
на странице Список миграций.
Важно, чтобы вы просмотрели, протестировали и проверили все перенесенные боты, чтобы
убедиться, что они успешно работают в среде Automation 360.
Помощник по миграции объединен с помощником по поиску ошибок, что обеспечивает комплексное
представление всех строк в бот, которые требуют проверки или действий с вашей стороны или в
которых содержатся ошибки, и поэтому требуется их устранение. Эта функция поможет вам быстро
определить области боты, которые требуют вашего внимания. Перед тестированием любого бот
прокрутите весь перенесенный бот с первой до последней строки, чтобы Помощник по миграции
отметил проблемы.
Если вы не просмотрите весь бот, может появиться ошибка не удалось скомпилировать.

Обновление боты

Если бот требует каких-либо модификаций на основании отчетов о миграции или этапа
тестирования, вы можете отредактировать бот.
1. Выгрузите бот из общего репозитория в личный.
2. Используйте Помощник по миграции для просмотра изменений в перенесенных боты.

Помощник по миграции подскажет вам все необходимые изменения и предоставит возможности
для использования новых функций Automation 360.

3. При необходимости отредактируйте бот в Bot editor.
Вы можете запустить бот непосредственно из Bot editor по мере модификации бот и
протестировать этапы процесса.

Выполните эти действия в среде разработки (DEV). Когда перенесенные боты будут соответствовать
заданным критериям прохождения, переместите их в среду приемочного пользовательского
тестирования (UAT) для тестирования боты в системах производственного типа с большими
наборами данных.
Если бот удовлетворяет требованиям UAT, его можно развернуть в рабочей среде (PROD).
Этот процесс является частью типичных отраслевых стандартов жизненного цикла разработки
программного обеспечения (SDLC).

Перемещение боты с помощью Bot Lifecycle Management

Используйте Bot Lifecycle Management для перемещения боты из одной среды в другую. Когда вы
протестировали и успешно запустили перенесенные боты в среде разработки (DEV), вы можете
использовать Bot Lifecycle Management для перемещения боты из среды разработки в среду UAT.
Аналогичным образом, используйте Bot Lifecycle Management для перемещения боты из среды UAT в
рабочую среду (PROD).
Если при перемещении боты возникает ошибка Невозможно создать каталог: <название
каталога>", см. Unable to import or export the bots from v11 to Automation 360 (A-People login required).
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Версия совместимости Бот

Если после миграции вы удалите AAApplicationPath из пути назначения и на 1 установлена
версия совместимости бот, то развертывание бот завершается сбоем. Это происходит потому, что в
версии 1 во время компиляции выполняется синтаксический анализ пути к файлу. В зависимости от
ОС, на которой работает устройство Control Room, (Linux или Windows), пути к файлам или папкам
могут отличаться, что может привести к ошибке при синтаксическом анализе этого пути во время
компиляции бот.

Recommendation:  Измените версию совместимости бот на 2. В этой версии во время выполнения
бот выполняется синтаксический анализ пути к файлу в зависимости от устройства, на котором
запускается бот.

See the following video on how to validate changes made to migrated боты:

Related reference
Сопоставление пакетов для миграции on page 1258
На этой странице содержится информация о командах Enterprise 10 и Enterprise 11 и о том, как
они связаны с соответствующими действиям или пакетами Automation 360. В некоторых случаях
команды Enterprise 10 или Enterprise 11 переносятся в более чем одно действие Automation 360. Это
необходимо для того, чтобы убедиться, что поведение перенесенного бот остается неизменным.
Сопоставление переменных для миграции on page 1293
При миграции некоторые переменные из предыдущих версий продукта напрямую сопоставляются
с Automation 360, в то время как другие переменные ведут себя иначе или имеют измененную
конфигурацию.

Сопоставление пакетов для миграции
На этой странице содержится информация о командах Enterprise 10 и Enterprise 11 и о том, как
они связаны с соответствующими действиям или пакетами Automation 360. В некоторых случаях
команды Enterprise 10 или Enterprise 11 переносятся в более чем одно действие Automation 360. Это
необходимо для того, чтобы убедиться, что поведение перенесенного бот остается неизменным.

В Automation 360 есть новый пакет с именем Автоматизация предыдущих версий. Этот
пакет обеспечивает дополнительную поддержку, необходимую во время миграции. The Legacy
automation package is for use during migration only; we do not recommend using this package for new
бот development. Legacy Automation пакет on page 1682
Вы можете переносить боты, когда пользователь, выполняющий миграцию, использует
аутентифицированный прокси-сервер.

Note:  Для получения списка пакеты и actions, которые поддерживают миграцию и преобразование
боты Internet Explorer из Enterprise 11 или Enterprise 10 в Automation 360 с поддержкой Edge в
режиме IE см. в разделе Пакеты и действия.

Active Directory

Соответствующие команды Active Directory переносятся в рамках действий Подключить и
Отключить. Каждая команда переносится следующим образом.
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Команды Enterprise 11 или Enterprise 10 Эквивалентные пакеты и actions
Automation 360

Создать пользователя Создать пользователя

Команда Изменить группу с выбранным параметром
Переименовать группу

Переименовать группу

Команда Изменить группу с выбранным параметром
Удалить группу

Удалить группу

Команда Изменить группу с выбранным параметром
Добавить пользователей в группу

Добавить пользователей в
группу

Команда Изменить группу с выбранным параметром
Удалить пользователей из группы

Удалить пользователей из
группы

Команда Изменить группу с выбранным параметром
Установить свойство

Установить свойство группы

Команда Изменить группу с выбранным параметром
Отключить учетную запись пользователя

Отключить учетную запись
пользователя

Команда Изменить группу с выбранным параметром
Обновить сведения о пользователе

Обновить сведения о
пользователе

Команда Изменить пользователя с выбранным
параметром Переименовать пользователя

Переименовать
пользователя

Команда Изменить пользователя с выбранным
параметром Удалить пользователя

Удалить пользователя

Команда Изменить пользователя с выбранным
параметром Включить учетную запись пользователя

Включить учетную запись
пользователя

Команда Изменить пользователя с выбранным
параметром Обновить параметры учетной записи

Обновить параметры
учетной записи

Команда Изменить пользователя с выбранным
параметром Изменить пароль

Изменить пароль

Команда Создать объект с выбранным параметром
Объект-компьютер

Объект-компьютер

Команда Создать объект с выбранным параметром
Объект подразделения

Создать подразделение

Команда Поиск с выбранным параметром Выполнить
запрос

Выполнить запрос

Команда Поиск с выбранным параметром Получить всех
пользователей группы

Получить всех
пользователей группы

Команда Получить свойство с выбранным параметром
Пользователь

Получить свойство
пользователя

Команда Получить свойство с выбранным параметром
Группа

Получить свойство группы

Команда Получить свойство с выбранным параметром
Компьютер

Получить свойство
компьютера

Команда Получить свойство с выбранным параметром
Подразделение

Получить свойство
подразделения
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Команды Enterprise 11 или Enterprise 10 Эквивалентные пакеты и actions
Automation 360

Команда Изменить объект с типом объекта Компьютер
и выбранным параметром Переименовать объект

Переименовать компьютер

Команда Изменить объект с типом объекта Компьютер
и выбранным параметром Удалить объект

Удалить компьютер

Команда Изменить объект с типом объекта Компьютер
и выбранным параметром Переместить объект

Переместить компьютер

Команда Изменить объект с типом объекта Компьютер
и выбранным параметром Установить свойство

Установить свойство
компьютера

Команда Изменить объект с объектом Подразделение и
выбранным параметром Переименовать объект

Переименовать
подразделение

Команда Изменить объект с объектом Подразделение и
выбранным параметром Удалить объект

Удалить подразделение

Команда Изменить объект с объектом Подразделение и
выбранным параметром Переместить объект

Переместить подразделение

Команда Изменить объект с объектом Подразделение и
выбранным параметром Установить свойство

Установить свойство
подразделения

См. раздел Active Directory пакет on page 1392.

Интеграция приложений
Интеграция приложений в Automation 360 не имеет действий для каждой технологии в отличие
от Enterprise 10/Enterprise 11. В Automation 360 все действия разделены на отдельные действия.

Команды Enterprise 11 или Enterprise 10 Эквивалентные пакеты и actions Automation
360

Команды Интеграция приложений,
записывающие текст из окна

action Получить текст из окна из пакет
Интеграция приложений

Команда Изменить группу с выбранным
параметром Переименовать группу

Переименовать группу

Команда Изменить группу с выбранным
параметром Удалить группу

Удалить группу

Команда Изменить группу с выбранным
параметром Добавить пользователей в
группу

Добавить пользователей в группу

боты Enterprise 11, которые изменяют размер окна приложения при развертывании, могут быть
перенесены в Automation 360.
См. раздел Интеграция приложений пакет on page 1411.
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Буфер обмена

Все команды буфера обмена переносятся в эквивалентные действия пакета Automation 360 Буфер
обмена. Изменения в поведении или имени команды отсутствуют.
См. раздел Буфер обмена пакет on page 1449.

Комментарий

Комментарий перенесена в действие Automation 360 Комментарий.
Если команда Комментарий содержит переменную или символ $, команда отключается после
миграции.

База данных

Enterprise 10/Enterprise 11 использует драйверы ODBC, а Automation 360 использует драйверы JDBC.
Действие SQL-запрос называется Прочитать из в Automation 360.
В следующей таблице показаны команды, которые в настоящее время можно перенести.

Команды
Enterprise 11 или
Enterprise 10

Эквивалентные пакеты и actions Automation 360

Подключить Переносится в команду Подключить. Причины возникновения
неподдерживаемых строк подключения, обнаруженных в разделе
Automation 360, могут быть разными в зависимости от вашей среды.
Дополнительные сведения можно получить в процессе миграции.
Обратитесь в службу технической поддержки, если вам нужна помощь в
решении проблемы.
«0» не является допустимым значением времени ожидания в Automation
360. В процессе миграции «0» заменяется пустым значением.

Выполнить
хранимую
процедуру

Имя параметра и выходной параметр — это обязательные поля в
Automation 360.

Important:  После миграции бот вы должны указать имя параметра и
тип выходного параметра в action Выполнить хранимую процедуру.

См. раздел База данных пакет on page 1463.

Задержка

Команда «Задержка» переносится в действие Задержка в Automation 360. Параметры «Задержка
в миллисекундах» и «Задержка в секундах» (Enterprise 11) были заменены на переключатели в
области Единица времени (Automation 360). См. раздел Задержка пакет on page 1491.
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Эл. почта

Сеансы для команд электронной почты в Enterprise 10 или Enterprise 11. Однако Automation 360
включает в себя действия Подключить и Отключить для обеспечения запуска и закрытия
сеансов электронной почты. Поэтому во время миграции действие Подключить помещается
перед соответствующим действием электронной почты, а действие Отключить — после
соответствующего действия электронной почты.
Параметр Сохранить вложение команды Получить все сообщения теперь является
специальным действием с именем Сохранить вложение в пакете Электронная почта в
Automation 360.
Для боты, которые созданы для автоматизации задач, связанных с электронной почтой, на сервере
Exchange Web Services (EWS), команда Получить все сообщение переносится в действие Цикл
с итерацией, для которой установлено значение Для каждого сообщения в почтовом ящике.
Аналогичным образом, командыУдалить и Удалить все переносятся в действия Удалить и
Удалить все.
When you migrate Enterprise 11 боты that contain the Эл. почта package with Authentication type set
to OAuth2, most of the parameters included in the package migrate to the same values in Automation
360. However, the following parameters migrate with different values:
• The IMAP and POP3 protocols migrate to the corresponding Email server in Automation 360.
• The Use Local timezone migrates to the Loop action as a Boolean value in Automation 360.

См. раздел Эл. почта пакет on page 1506.

Обработка ошибок

Отключенные команды Обработка ошибок не переносятся в Automation 360.
Начать обработку ошибок и Завершить обработку ошибок переносятся в блок
Попробовать/Выявить пакета Обработчик ошибок в Automation 360. Многие параметры,
доступные в команде «Начать обработку ошибок», переносятся в соответствующие действия
Automation 360.

Note:  To avoid an exception error when you use the Try/Catch block in a Цикл, we recommend that
you validate all the command inputs.

Подробные сведения см. в приведенной ниже таблице.

Команды
Enterprise 11
или Enterprise
10

Эквивалентные пакеты и actions Automation 360

Продолжить По умолчанию выполнение продолжается после выполнения блока
Выявить в Automation 360.

Остановить Действие Остановить пакета Задача добавляется в блок Выявить.
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Команды
Enterprise 11
или Enterprise
10

Эквивалентные пакеты и actions Automation 360

Сделать
снепшот

Если выбран параметр Сделать снепшот, а в поле Путь к файлу
бот Enterprise 11 указано расположение, перенесенный бот содержит
следующее.
• Действие Захватить рабочий стол из пакет Экран для захвата экрана

ошибки.
• Действие Записать в файл из пакет Записать в файл для записи

сообщения об ошибке в текстовый файл.
• Действие В строку из пакет Дата/время для преобразования значения

даты/времени в строковое значение, которое будет сохранено в
текстовом файле вместе с сообщением об ошибке.

Вышеуказанные действия добавляются в блок Выявить перенесенного
бот, а изображение на снимке и сообщение об ошибке сохраняются в
расположении, указанном в поле Путь к файлу в бот Enterprise 11.
Если выбраны параметры Сделать снепшот, Отправить сообщение
электронной почты и Прикрепить снепшот, а в поле Путь к файлу
в бот Enterprise 11 не указано расположение, перенесенный бот содержит
следующее.
• action Создать из пакет Папка для создания временного расположения

для сохранения полученного изображения и текстового файла,
содержащего сообщение об ошибке.

• Действие Захватить рабочий стол из пакет Экран для захвата экрана
ошибки.

• Действие Записать в файл из пакет Записать в файл для записи
сообщения об ошибке в текстовый файл.

• Действие В строку из пакет Дата/время для преобразования значения
даты/времени в строковое значение, которое будет сохранено в
текстовом файле вместе с сообщением об ошибке.

• action Отправить из пакет Эл. почта для отправки уведомления по
электронной почте с прикрепленным изображением и текстовым
файлом.

• action Удалить из пакет Файл для удаления изображения и текстового
файла, хранящихся во временном расположении.

Вышеуказанные actions добавляются в блок Выявить перенесенного бот.

Выполнить
задачу

Действие Запустить из пакета Задача добавляется в блок Попробовать.
Когда дочерний бот сталкивается с ошибкой, бот продолжает выполнение
следующего действия родительского бот.

Записать
данные в файл

Действие Записать в файл добавляется в блок Выявить.

Отправить
сообщение эл.
почты

Действие Отправить из пакета Эл. почта добавляется в блок Выявить.
Переменные TaskBot и значения переменных, отправленные в качестве
вложения электронной почты с помощью параметра Прикрепить
переменную», также переносятся.
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Команды
Enterprise 11
или Enterprise
10

Эквивалентные пакеты и actions Automation 360

Присвоение
переменных

Действие Присвоить из пакета Строка добавляется с соответствующим
условием в блок Выявить.

См. раздел Обработчик ошибок пакет on page 1536.

Excel

Команды Excel Enterprise 10/Enterprise 11 переносятся в соответствующие действия Automation 360
из пакета Расширенный Excel.
В Enterprise 11 бот может открыть электронную таблицу Microsoft Excel, даже если расширение
файла не указано. В Automation 360 перенесенный боты использует действие Открыть в пакете
Расширенный Excel для открытия электронной таблицы Microsoft Excel, если расширение файла не
указано.
В Enterprise 10/Enterprise 11 данные, возвращаемые командами Получить несколько ячеек и
Получить все ячейки возвращаются в команду Цикл > Каждая строка в наборе данных
Excel. В Automation 360 функциональные возможности Получить несколько ячеек и Получить
все ячейки доступны в действии Цикл > Каждая строка в наборе данных Excel, поэтому
значения из этих команд переносятся в цикл вместо фактических действий.
Боты, которые используют команду Получить одну ячейку с параметрами Определенная
ячейка и Получить значение ячейки, переносятся в action Получить одну ячейку из пакет
Расширенный Excel с выбранными параметрами Определенная ячейка и Прочитать значение
ячейки после миграции.
When you run a migrated бот with the Excel Advanced > Cell range option, ensure that you use a
numeric value as the last character in the From cell and To cell fields (for example, testa1). The last
character cannot be an alpha character.
В следующей таблице показаны измененные имена действий.

Команды Enterprise 11
или Enterprise 10

Эквивалентные пакеты и actions Automation 360

Сохранить электронную
таблицу

Сохранить книгу

Открыть электронную
таблицу

Открыть

Закрыть электронную
таблицу

Закрыть

Note:  При миграции бот с использованием Excel:Действие
Закрыть в Enterprise 10/Enterprise 11, бот игнорирует параметр
Сохранить для файла, доступного только для чтения, в то время
как в Automation 360, отображается следующий запрос: Файл
уже существует.
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Команды Enterprise 11
или Enterprise 10

Эквивалентные пакеты и actions Automation 360

Получить ячейки Разделено на действия Получить одну ячейку и Получить
несколько ячеек

Note:  Действие Получить ячейки извлекает выходные
данные в различных форматах для Enterprise 10/Enterprise 11
и Automation 360 для определенных типов данных, таких как
«Логический» и «Дата».

Активировать лист Переключиться на лист

Note:  В Enterprise 11 бот, содержащий команду Активировать
лист, не переключается на скрытый рабочий лист и не
выполняет с ним операции. Однако после миграции в Automation
360 бот, содержащий эквивалентное действие Переключиться
на лист, переключается на скрытый лист и выполняет с ним
операции. После завершения операций лист остается скрытым и
не активируется.

Найти/заменить Разделено на действия Найти и Заменить
Когда вы выполняете миграцию бот с помощью действия Excel
> Найти и если это значение присутствует в начале адреса
ячейки, перенесенный бот извлекает те же выходные результаты
в другой последовательности для параметра Найти текст для
Enterprise 11 и Automation 360. Например, если адреса ячеек
A2, B5 и D15 имеют значение XYZ и вы ищете XYZ в диапазоне
A2:D15, то бот Enterprise 11 собирает результаты в такой
последовательности: B5, D15 и A2. Однако перенесенный бот
будет собирать результаты в другой последовательности: A2, B5
и D15 после миграции в Automation 360.

См. раздел Расширенный Excel пакет on page 1546.
• В Enterprise 11, Enterprise 10 и Automation 360 сеанс (используемый для открытия электронной

таблицы Microsoft Excel) может совместно использоваться родительским бот и дочерним бот. В
Automation 360 вы можете закрыть такой общий сеанс из дочернего бот.

Note:  При использовании нескольких электронных таблиц для автоматизации операции
необходимо использовать разные имена сеансов для каждой электронной таблицы. Если вы
хотите использовать одно и то же имя сеанса для автоматизации всех электронных таблиц, вы
должны сначала закрыть сеанс одной электронной таблицы, а затем использовать то же имя
сеанса для другой электронной таблицы.

• В Enterprise 11 или Enterprise 10 при попытке сохранить электронную таблицу, доступную только
для чтения, ошибка не отображается. Однако в Automation 360, когда вы пытаетесь сохранить
электронную таблицу, доступную только для чтения, отображается сообщение об ошибке,
уведомляющее о том, что книга не может быть сохранена.
Обходное решение. Убедитесь, что у вас есть доступ у функции Редактировать для
этого файла и повторите операцию. Если проблема сохранится, обратитесь к системному
администратору. Действие Записать для таких файлов запрещено.
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Файл и папка

Все команды Файл/папка разделены на пакеты Файл и Папка.
Следующие действия, связанные с командой Файл, изменены в Automation 360.

Команды Enterprise 11 или
Enterprise 10

Эквивалентные пакеты и actions Automation 360

Копировать файлы Действие копирования из пакет Файл

Создать файлы Действие создания из пакет Файл

Создать ярлык файла action создания ярлыка из пакет Файл

Удалить файлы Действие удаления из пакет Файл

Открыть файлы Действие открытия из пакет Файл

Печать файлов Действие печати из пакет Файл

Переименовать файлы Действие переименования из пакет Файл

Извлечь файлы Действие извлечения из пакет Папка

Архивировать файлы Действие архивации из пакет Папка

Следующие действия, связанные с командой Папка, были изменены в Automation 360.

Команды Enterprise 11 или
Enterprise 10

Эквивалентные пакеты и actions Automation 360

Копировать папку Действие копирования из пакет Папка

Создать папку Действие создания из пакет Папка

Создать ярлык папки action создания ярлыка из пакет Папка

Удалить папку Действие удаления из пакет Папка

Открыть папку Действие открытия из пакет Папка

Переименовать папку Действие переименования из пакет Папка

См. Файл пакет on page 1575 и Папка пакет on page 1584.
боты Enterprise 11 могут использовать регулярные выражения в командах Копировать файлы,
Удалить файлы, Печать нескольких файлов, Переименовать файлы и Архивировать
файлы для поиска файлов, с которыми нужно выполнить операцию. Эквивалентные действия в
Automation 360 также могут использовать регулярные выражения для поиска файлов, с которыми
нужно выполнить операцию.

FTP/SFTP

Все команды FTP/SFTP переносятся в эквивалентные действия Automation 360 пакета FTP/SFTP.
Изменения в поведении или имени команды отсутствуют.
Действия Получить файлы и Получить папку возвращают ошибки во время выполнения,
если они имеют дополнительные критерии, зависящие от дат, которые предоставлены в качестве
переменных со значениями в формате, отличном от ММ/ДД/ГГГГ. Такие экземпляры необходимо
исправить после миграции бот. Во время процесса миграции эти два действия также добавляют
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дополнительные обработчики ошибок в перенесенный боты, когда фильтрация выполняется по
дате/времени.

Если/иначе

Переменные, содержащие условие строки “Если” со следующими операторами переносится
в Automation 360 в качестве условия строки.
• =
• < >
• Включить
• Не включает

Для переменной Случайная подтипа Строка
Automation 360 добавляет действие Создать
случайную строку из пакета Строка для
создания случайной строки над условием «Если»
и присваивает значение соответствующей
перенесенной переменной.

Переменная, содержащая числовое
условие

“Если” со следующими операторами переносится
в Automation 360 в качестве числового условия.
• >=
• <=
• >
• <

Для переменной Случайная подтипа Число
Automation 360 добавляет действие Присвоить
случайное число из пакета Число для
создания случайной строки над условием «Если»
и присваивает значение соответствующей
перенесенной переменной.

Переменная типа значения, содержащая
дату

Система пытается определить, имеет ли
условие переменной значение даты. Если оно
найдено, «Если» переносится вместе с условием
«Дата/время» в Automation 360. В противном
случае система переносит его в качестве
строкового или числового условия в зависимости
от используемого оператора. В этом случае вы
должны изменить его на условие даты после
миграции бот, если используется операция с
датой.
Кроме того, возможно, вам придется изменить
формат даты на тот, который будет совместим
с вашими данными. По умолчанию для
преобразования даты в строку используется
формат MM/dd/yyyy HH:mm:ss.
См. раздел Если пакет on page 1639.

Распознавание изображений Команда Если с условием Распознавание
изображений в Enterprise 10/Enterprise 11
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может стать одним из следующих действий в
Automation 360 в зависимости от выбранных в
Enterprise 10/параметров.
• Если > Файл изображения найден

в файле изображения — создается,
если Изображение 1 имеет выбранный
параметр Из файла и Изображение 2 имеет
выбранный параметр Из файла в Enterprise
10 или Enterprise 11.

• Если > Файл изображения найден в
окне — создается, если Изображение 1
имеет выбранный параметр Из файла и
Изображение 2 имеет выбранный параметр
Из окна в Enterprise 10 или Enterprise 11.

• Если > Окно найдено в файле
изображения — создается, если
Изображение 1 имеет выбранный параметр
Из окна и Изображение 2 имеет выбранный
параметр Из файла в Enterprise 10 или
Enterprise 11.

• Если > Окно найдено в окне — создается,
если Изображение 1 имеет выбранный
параметр Из окна и Изображение 2 имеет
выбранный параметр Из окна в Enterprise 10
или Enterprise 11.

См. раздел Если пакет on page 1639.

Important:  Если условие включает в себя дату, то в определенной ситуации после миграции бот
потребуется изменить перенесенную информацию на условие даты.

В таблице ниже показано, как различные условия переносятся в соответствующие условия
Automation 360.

Команды Enterprise 11 или
Enterprise 10

Эквивалентные пакеты и actions Automation 360

«Задача успешно
выполнена» или «Задача не
выполнена»

Перенесено в эквивалентное условие Если пакета TaskBot.

«Сценарий успешно
выполнен» или «Сценарий
не выполнен»

«Сценарий успешно выполнен» или «Сценарий не выполнен»
переносятся в соответствующие действия Если > Сценарий
успешно выполнен и Если > Сценарий не выполнен
пакета Автоматизация предыдущих версий.

Свойства объекта Перенесено в условия Если > Условие > Окно существует и
Объект пакета Средство записи.

«Приложение запущено»
или «Приложение не
запущено»

Перенесено в эквивалентное условие «Если» пакета
Приложение.

«Файл существует», «Файл
не существует», «Дата
файла», «Размер файла»

Перенесено в эквивалентное условие «Если» пакета Файл.
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Команды Enterprise 11 или
Enterprise 10

Эквивалентные пакеты и actions Automation 360

«Папка существует» или
«Папка не существует»

Перенесено в эквивалентное условие «Если» пакета Папка.

«Запрос ping успешно
выполнен» или «Запрос
ping не выполнен»

Перенесено в эквивалентное условие «Если» пакета Ping.

«Веб-элемент управления
существует» или
«Веб-элемент управления
не существует»

Перенесено в эквивалентное условие «Если» пакета
Автоматизация предыдущих версий.

«Окно существует»/«Окно
не существует»

Следующие команды с выбранным параметром «Показывать
дочерние и скрытые окна» переносятся в пакет Automation 360
Автоматизация предыдущих версий.
• Если > Условие > Окно существует
• Если > Условие > Окно не существует

«Логика успешна»/«Логика
неудачна»

Команда Если переносится в Если > Задача успешно
выполнена и Если > Задача не выполнена соответственно.
Команда Else If переносится в Else If > Задача успешно
выполнена и Else If > Задача не выполнена
соответственно.
Боты, которые используют условие Логика успешна или
Логика неудачна и возвращают выходную переменную
родительскому бот, могут быть перенесены в Automation 360.
Боты, которые используют переменные Credential Vault,
передаются от одной Логика MetaBot к другой Логика MetaBot
для обоих команд ЕСЛИ > Логика успешна и ЕСЛИ >
Логика неудачна.
Вы можете выполнить миграцию MetaBot с Логика
(родительской), которая содержит переименованную Логика
(дочернюю). Если дочерняя Логика переименовывается после
ее сопоставления с родительской Логика, то это сопоставление
родительской Логика переносится с новым именем.
Применяется с v.25: боты Enterprise 11 или Enterprise 10,
которые используют команду Если > Логика успешна
или Если > Логика неудачна, переносятся, когда
переименовывается Логика MetaBot или изменился
относительный путь после сопоставления. Если Логика MetaBot
переименована или изменен путь после сопоставления в
TaskBots, то теперь миграция TaskBots выполняется с новым
именем или путем Логика MetaBot.
For information about how a бот is migrated if the Logic
Successful command passes a Credential Vault variable, see
Запустить логику on page 1282.
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Команды Enterprise 11 или
Enterprise 10

Эквивалентные пакеты и actions Automation 360

Service is running/Service is
not running

The If command is migrated to If > Service is running and If >
Service is not running.
The ElseIf command is migrated to Else If > Service is running
and Else If > Service is not running.

Распознавание изображений

Команда Распознавание изображений разделена на действия Поиск файла изображения в
окне и Поиск изображения окна в другом окне в Automation 360.
В Automation 360 параметр Расширенное используется в качестве режима сравнения
по умолчанию. Другие режимы сравнения (такие как Градации серого, Нормальное и
Монохромное), которые существовали в Enterprise 10 и Enterprise 11, скрыты в Automation 360,
но соответствуют поведению Automation 360 после миграции. В процессе миграции информация
отображается автоматически и не влияет на связанные боты.
When you run a migrated бот with Распознавание изображений that contains an Если, IF/ELSE, or Цикл
action, an error displays when the window does not exist.
Миграция боты с командой Распознавание изображений может завершиться сбоем, если
команда использует любой тип файла, кроме следующих:
• .jpg
• .jpeg
• .jpe
• .jfif
• .bmp
• .gif

См. раздел Image Recognition пакет on page 1645.

Insert Keystrokes

Эта команда называется Имитация нажатия клавиш в Automation 360. Следующие соглашения о
нажатии клавиш изменились.

Команды Enterprise 11 или Enterprise 10 Эквивалентные пакеты и actions Automation 360

[PAGE UP] [PAGE-UP]

[NUM LOCK] [NUM-LOCK]

[SCROLL LOCK] [SCROLL-LOCK]

[PAGE DOWN] [PAGE-DOWN]

[CAPS LOCK] [CAPS-LOCK]

[СТРЕЛКА ВВЕРХ] [СТРЕЛКА-ВВЕРХ]

[СТРЕЛКА ВЛЕВО] [СТРЕЛКА-ВЛЕВО]

[ПРАВЫЙ ЩЕЛЧОК] [МЕНЮ]

© 2023 Automation Anywhere. All rights reserved.     1270



    Automation Anywhere - Миграция в Automation 360

Команды Enterprise 11 или Enterprise 10 Эквивалентные пакеты и actions Automation 360

[СТРЕЛКА ВПРАВО] [СТРЕЛКА-ВПРАВО]

[СТРЕЛКА ВНИЗ] [СТРЕЛКА-ВНИЗ]

[ALT GR DOWN] [ALT-GR DOWN]

[ALT GR UP] [ALT-GR UP]

[$] [ДОЛЛАР]

In Enterprise 11 or Enterprise 10, the delay time is divided by the total characters and applied between
each character stroke. В Automation 360 указанная вами задержка применяется ко времени между
каждым нажатием клавиши.
The legacy Get keystrokes delay action in Automation 360 supports migrated боты that include the
Simulate keystrokes action. The legacy Get keystrokes delay action matches the duration of delay
defined in Enterprise 11 боты for the Insert Keystrokes command and simulates the same value in
Automation 360 for the Simulate keystrokes action. Если после миграции клавиши нажимаются
быстрее (например, клавиши, используемые в сочетаниях в Office 365 Excel), добавьте action
Задержка после action Имитировать нажатия клавиш, чтобы обеспечить запуск боты без
проблем. The legacy Get keystrokes delay action provides similar delay, as seen in Enterprise 11, in
the migrated боты to ensure that the migrated боты produce the same output as seen in Enterprise 11.
However, this change leads to the command being split into multiple lines after migration.
Если выбран параметр Зашифровать нажатия клавиш в боты Enterprise 11 или Enterprise 10,
после миграции значение сохраняется в Credential Vault. В процессе миграции в Credential Vault
создается ячейка со следующими атрибутами.
• Имя ячейки, созданной в Automation 360 — это имя AAE_<имя_папки> («имя_папки» — это

папка, в которой хранится перенесенный бот).
Перенесенный бот использует эту ячейку. Пользователи, имеющие любое разрешение для папки,
в которой хранится бот, могут получить доступ к ячейке. Пользователь, выполняющий миграцию,
должен иметь разрешение Создать стандартные атрибуты для учетных данных.

• В ячейке хранятся только один компонент учетных данных для каждого бот. Имя созданного
компонента учетных данных — Keystrokes_<имя бота> для TaskBots и Keystrokes_<имя
 MetaBot>_<имя логики> для MetaBots.

• Атрибуты для ячейки создаются с именем Encrypted_keystrokes.

Если ячейка, учетная запись или атрибут с таким именем уже существует, система добавляет к
имени ячейки, учетной записи или атрибута числовое значение. Например, AAE_<имя_папки>_1,
Keystrokes_<имя_бота>_1 и Encrypted_keystrokes_1 соответственно. Если имя ячейки,
учетной записи или атрибута содержит более 50 символов, лишние символы в конце имени будут
обрезаны системой для соответствия ограничению в 50 символов.

Note:  Вы не можете перенести бот, который доступен на локальном устройстве, если выбран
параметр Зашифровать нажатия клавиш.

См. раздел Имитация нажатия клавиш пакет on page 1881.

Launch Website

Эта команда перенесена в action Открыть в пакете Браузер в Automation 360.
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Если выбор параметров Edge или Заменить браузер по умолчанию отменен для команд в
предыдущих версиях продукта, после миграции эти команды автоматически используют параметр
Браузер по умолчанию.
боты Enterprise 11, которые открывают веб-сайты в новом окне всех браузеров, поддерживаемых
Automation 360, могут быть перенесены. боты Enterprise 11, которые открывают веб-сайты в новой
или существующей вкладке браузера Internet Explorer, могут быть перенесены в Automation 360.
Эквивалентный параметр открытия веб-сайтов в новом окне, новой или существующей вкладке
выбирается в перенесенном боты.

Note:  Поддержка устаревших версий браузера Microsoft Edge больше не осуществляется, но
браузер Microsoft Edge Chromium поддерживается. В результате вы не сможете создавать новые
боты с помощью предыдущих версий браузера Microsoft Edge. Однако существующие боты,
созданные с помощью предыдущих версий браузера Microsoft Edge, можно изменять с помощью
других поддерживаемых браузеров, таких как Google Chrome или Microsoft Edge Chromium.

См. раздел Браузер пакет on page 1438.

Important:  Если вы создали боты в Enterprise 11 или Enterprise 10, используя браузер Microsoft
Edge, сначала вам потребуется импортировать боты в другой браузер, а затем их можно будет
перенести.

Записать в файл

Эта команда перенесена в действие Записать в файл в Automation 360.
См. раздел Записать в файл пакет on page 1694.

Цикл
В следующей таблице показано, как команда Цикл переносится в эквивалентные actions и пакеты
Automation 360.

Команды Enterprise 11 или
Enterprise 10

Эквивалентные пакеты и actions Automation 360

Команда Цикл с выбранным
параметром Число раз

action Цикл из пакет Цикл с выбранным параметром n раз.

Команда Цикл с выбранным
параметром Список

action Цикл из пакет Цикл с выбранным параметром n раз.

Команда Цикл с выбранным
параметром Каждая строка
в наборе данных Excel

action Цикл из пакет Цикл с выбранным параметром Для
каждой строки на листе.
Системная переменная $Excel Column$, используемая внутри
цикла, теперь определяется пользователем и указывается в
том же итераторе.

Команда Цикл с выбранным
параметром Каждая
строка в наборе данных
SQL-запроса

action Цикл из пакет Цикл с выбранным параметром Для
каждой строки в наборе данных SQL-запроса.
Системная переменная $Dataset Column$, используемая
внутри цикла, теперь определяется пользователем и
указывается в том же итераторе.
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Команды Enterprise 11 или
Enterprise 10

Эквивалентные пакеты и actions Automation 360

Команда Цикл с выбранным
параметром Каждый файл
в папке

action Цикл из пакет Цикл с выбранным параметром Для
каждого файла в папке.
Теперь системные переменные $Filename$ и $Extension
$ — это имена ключей и расширения переменных словаря,
указанные в том же итераторе. Если папка отсутствует в
Enterprise 11, боты не столкнутся с ошибкой. In Automation
360, the migrated боты encounter an error if the folder does not
exist.

Команда Цикл с выбранным
параметром Каждая папка
в папке

action Цикл из пакет Цикл с выбранным параметром Для
каждой папки в папке.
Системная переменная $Folder name$, используемая внутри
цикла, теперь определяется пользователем и указывается в
том же итераторе. Если папка отсутствует в Enterprise 11, боты
не столкнутся с ошибкой. In Automation 360, the migrated боты
encounter an error if the folder does not exist.

Команда Цикл с выбранным
параметром Каждая строка
в CSV/текстовом файле

action Цикл из пакет Цикл с выбранным параметром Для
каждой строки в CSV/TXT.
Системная переменная $Filedata Column$, используемая
внутри цикла, теперь определяется пользователем и
указывается в том же итераторе.

Команда Цикл с выбранным
параметром Каждое
сообщение электронной
почты на почтовом
сервере

action Цикл из пакет Цикл с выбранным параметром Для
каждого сообщения в почтовом ящике.
Системные переменные $Email Cc$,  $Email From$, $Email
Message$, $Email Received Date$, $Email Received Time
$, $Email Subject$ и $Email To$ теперь являются ключами
emailCc, emailFrom, emailMessage, emailReceivedDate,
emailReceivedTime, emailSubject и emailTo переменных
словаря, указанных в том же итераторе, соответственно.

Команда Цикл с выбранным
параметром Каждый узел в
базе данных XML

action Цикл из пакет Цикл с выбранным параметром Для
каждого узла в базе данных XML.
Системная переменная $XML Data Node$$, используемая
внутри цикла, теперь определяется пользователем и
указывается в том же итераторе.

Следующие команды с выбранным параметром Показывать дочерние и скрытые окна
переносятся в пакет Automation 360 Автоматизация предыдущих версий.
• Цикл > Условие > Окно существует
• Цикл > Условие > Окно не существует

Переменные, содержащие условие строки “Если” со следующими операторами переносится
в Automation 360 в качестве условия строки.
• =
• < >
• Включить
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• Не включает

Для переменной Случайная подтипа Строка
Automation 360 добавляет действие Создать
случайную строку пакета Строка для
создания случайной строки над условием «Если»
и присваивает значение соответствующей
перенесенной переменной.

Переменная, содержащая числовое
условие

“Если” со следующими операторами переносится
в Automation 360 в качестве числового условия.
• >=
• <=
• >
• <

Для переменной Случайная подтипа Число
Automation 360 добавляет действие Присвоить
случайное число пакета Число для создания
случайной строки над условием «Если» и
присваивает значение соответствующей
перенесенной переменной.

Переменная, содержащая условия даты Система пытается определить, имеет ли
условие переменной значение даты. Если
оно найдено, «ЕСЛИ» переносится вместе с
условием «Дата/время» в Automation 360. В
противном случае система переносит его в
качестве строкового или числового условия в
зависимости от используемого оператора. В этом
случае вы должны изменить его на условие даты
после миграции бот, если используется операция
с датой.
Кроме того, возможно, вам потребуется
изменить формат даты на тот, который будет
совместим с вашими данными. По умолчанию
для преобразования даты в строку используется
формат MM/dd/yyyy HH:mm:ss.

Переменная типа списка Цикл с условием переменной типа «Список»
переносится в условие «Строка» или «Число»
в зависимости от оператора, используемого в
условии. Система использует индекс списка для
проверки условия.

«Веб-элемент управления существует» или
«Веб-элемент управления не существует»

Цикл с условиями Веб-элемент управления
существует и Веб-элемент управления не
существует переносится в Цикл > Условия
While «Веб-элемент управления существует»
и «Веб-элемент управления не существует»
пакета Автоматизация предыдущих версий
соответственно.

См. следующую таблицу, чтобы понять, как различные условия переносятся в соответствующие
условия Automation 360.
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Условия Enterprise 11 или
Enterprise 10

Эквивалентные пакеты и actions Automation 360

«Веб-элемент управления
существует» или «Веб-элемент
управления не существует»

Перенесено в эквивалентное условие «Если» пакета
Поддержка предыдущих версий.

Свойства объекта Перенесено в условие Объект пакета Средство записи.

«Приложение запущено» или
«Приложение не запущено»

Перенесено в эквивалентное условие «Если» пакета
Приложение.

«Файл существует», «Файл не
существует», «Дата файла»,
«Размер файла»

Перенесено в эквивалентное условие «Если» пакета
Файл.

«Папка существует» или «Папка
не существует»

Перенесено в эквивалентное условие «Если» пакета
Папка.

«Запрос ping успешно выполнен»
или «Запрос ping не выполнен»

Перенесено в эквивалентное условие «Если» пакета Ping.

«Служба запущена» или «Служба
не запущена»

Перенесено в эквивалентное условие «Если» пакета
Служба.

В следующей таблице показаны команды «Цикл», поддерживаемые для миграции, и их
соответствующие сопоставления в Automation 360.

Команды Enterprise 11 или Enterprise 10 Эквивалентные пакеты и actions Automation
360

Выйти из цикла Прервать

Продолжить

Message Box

Эта команда переносится в действие Окно сообщения в Automation 360.
См. раздел Message box package on page 1705.

Object Cloning

Эта команда переносится в пакет Средство записи > действие Запись в Automation 360.
Миграция поддерживается для приложений, использующих следующие технологии (в том числе, в
среде Citrix).
• MSAA (стандартная технология для рабочего стола)
• Браузер Google Chrome
• Браузер Internet Explorer
• Приложение Java для рабочего стола
• Приложение Java для веб-браузера
• Автоматизация пользовательского интерфейса (расширенная технология)
• Браузер Firefox (объект, основанный только на технологии HTML)
• Microsoft Silverlight версии 5
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В следующей таблице перечислены различия в поведении между Enterprise 11/Enterprise 10 и
Automation 360.

Поведение Enterprise 11 или Enterprise 10 Поведение Automation 360

Команды GetAllChidrenName и
GetAllChidrenValue возвращают значения
переменных строкового типа.

Эквивалентные actions в Automation 360
возвращают значения типа «Список». Процесс
миграции объединяет значения списка и
сохраняет их в строковой переменной для
поддержания согласованного поведения бот в
разных выпусках.

В Enterprise 11 команда используется для
захвата элемента управления на изображении

Захватывается все изображение окна,
при этом элемент управления выделяется
красным прямоугольником

Клонирование объектов с помощью действия Экспорт в CSV в Enterprise 10/Enterprise 11
переносится в следующие комбинации пакетов/действий, потому что это действие отсутствует в
Automation 360.
• Действие Запись сохраняет записанную дату в переменную таблицы.
• Действие Записать в файл пакета Таблица данных используется для сохранения данных из

переменной таблицы в CSV-файл.

Заголовок окна копируется из исходной команды в целевое действие.
Координаты X, Y и заголовок окна также переносятся в Automation 360.
Режимы выполнения или запуска Координата и Изображение из Enterprise 11 переносятся
следующим образом actions.
Режим воспроизведения как координат.

Режим воспроизведения как координат Действия щелчками мыши. Действия
«Щелчок», «Правый щелчок», «Левый щелчок»,
«Средний щелчок» и «Двойной щелчок»
перенесены в действие «Мышь: Щелчок» в
виде комбинации «Кнопка» и «События».
Соответствующие кнопки мыши с событиями
переносятся, как показано ниже.
• «Щелчок» изменяется на «Щелчок левой

кнопкой»
• «Правый щелчок» изменяется на «Щелчок

правой кнопкой»
• «Левый щелчок» изменяется на «Щелчок

левой кнопкой»
• «Средний щелчок» изменяется на «Щелчок

средней кнопкой мыши»
• «Двойной щелчок» изменяется на «Двойной

щелчок левой кнопкой»

Получить текст Действие «Получить текст» переносится в
виде комбинации действий, включающих
в себя «Мышь: Щелчок» с параметром
«Щелчок левой кнопкой», «Буфер обмена»:
«Очистить/Замедлить/Имитировать нажатия
клавиш».
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Установить текст Действие «Установить текст» переносится
в виде комбинации действий, включающих
в себя «Мышь: Щелчок» с параметром
«Щелчок левой кнопкой», «Буфер обмена»:
«Очистить/Замедлить/Имитировать нажатия
клавиш».

В следующей таблице показаны изменения имен свойств для элементов управления и объектов,
записанных с помощью Клонирование объектов. В процессе миграции изменения имен
сопоставляются автоматически. Однако, если свойство используется внутри переменной, вы должны
вручную ввести новое имя в переменную.

Имя свойства Enterprise 11 или Enterprise 10 Имя свойства Automation 360

Код объекта Идентификатор

Тип Тип элемента управления

Состояния States

Действие DefaultAction

Полужирный IsBold

Курсив IsItalic

Подчеркивание IsUnderline

Зачеркивание IsStrikethrough

Верхний индекс IsSuperscript

Нижний индекс IsSubscript

Цвет фона BackgroundColor

Цвет переднего плана ForegroundColor

Шрифт FontFamily

Размер шрифта FontSize

Отступ первой строки FirstLineIndent

Отступ слева LeftIndent

Отступ справа RightIndent

Межстрочный интервал LineSpacing

Пространство сверху SpaceAbove

Пространство снизу SpaceBelow

Имя элемента ItemName

Значение элемента ItemValue

Анимированный IsAnimated

Стиль отрисовки концов линий Cap

Толщина шрифта FontWeight

Выравнивание по горизонтали HorizontalAlignment

Скрыто IsHidden
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Имя свойства Enterprise 11 или Enterprise 10 Имя свойства Automation 360

Только чтение IsReadOnly

Нижняя граница BottomMargin

Левая граница LeftMargin

Верхняя граница Верхняя граница

Правая граница RightMargin

Цвет надчеркивания OverlineColor

Цвет зачеркивания StrikethroughColor

Стиль вкладок Вкладки

Направление текста TextFlowDirection

Цвет подчеркивания UnderlineColor

Идентификатор HTML IEID

Имя HTML IEName

Атрибут Alt HTML IEAlt

Тег HTML IETag

Класс HTML IEClass

Внутренний текст HTML IEInnerText

Исходный индекс HTML IESourceIndex

Гиперссылка HTML IEHref

Значение HTML IEValue

Тип HTML IEType

Идентификатор класса HTML IEClassId

Заголовок HTML IETitle

Индекс тегов HTML IETagIndex

Свойство HasFrame HTML IEHasFrame

Идентификатор фрейма HTML IEFrameID

Имя фрейма HTML IEFrameName

Источник фрейма HTML IEFrameSrc

Ширина HTML IEWidth

Верхний край HTML IETop

Левый край HTML IELeft

Высота HTML IEHeight

Путь фрейма HTML IEFramePath

Набор элементов ItemCollection

Модуль OCR OCREngine
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Имя свойства Enterprise 11 или Enterprise 10 Имя свойства Automation 360

Периодичность OCR OCROccurrence

Тип элемента управления строками RowControlType

GetSelectedIndex GetSelectedIndex

GetSelectedText GetSelectedText

• В процессе миграции данные усекаются до 64 КБ, если боты Enterprise 11 или Enterprise 10,
использующие объект, и любые свойства этого объекта содержат данные размером более 64 КБ.
Это требуется для того, чтобы предотвратить возникновение ошибки боты после миграции.

• В Enterprise 11 можно удалить тип элемента управления объектом из критериев поиска, но этот
параметр недоступен в Automation 360. В Automation 360 действие записи выполняется только
для объектов с одинаковыми типами элементов управления. Если вы хотите использовать это
действие для объектов с различными типами элементов управления, вы должны записать эти
типы элементов управления в отдельных действиях записи.

См. раздел Using the Capture action on page 1778.

Распознавание текста (OCR)

Все команды OCR переносятся в эквивалентные действия Automation 360 пакета OCR. Изменения в
поведении или имени команды отсутствуют.
В Enterprise 11 параметры распознавания текста (OCR) ABBYY, MODI, TESSERACT и TOCR
доступны в качестве модулей OCR. В Automation 360 только ABBY используется в качестве модуля
OCR по умолчанию.
См. раздел Распознавание текста (OCR) пакет on page 1712.

Open Program/File
Эта команда переносится в действие Открыть программу/файл пакета Приложение. В
Enterprise 10/Enterprise 11 эта команда не выдает ошибку, если указать неверное значение в поле
Начать в. В Automation 360 во время выполнения бот происходит проверка значения, введенного в
это поле, и возникает ошибка.
См. раздел Приложение пакет on page 1415.

Important:  Пользователи должны изменить бот соответствующим образом, если они хотят
продолжить работу, даже если значения в поле «Начать в» указано неверно.

Интеграция с PDF

В следующей таблице показана команда Интеграция с PDF и эквивалентные ей actions и пакеты в
Automation 360.

Команды Enterprise 11 или Enterprise 10 Эквивалентные пакеты и actions Automation
360

Объединить документ Объединить документ

PDF в изображение Извлечь изображение
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Команды Enterprise 11 или Enterprise 10 Эквивалентные пакеты и actions Automation
360

Извлечь поля формы Извлечь поле

Извлечь текст Извлечь текст

Разделить документы Разделить документы

Зашифровать документ Зашифровать документ

Расшифровать документ Расшифровать документ

Если бот Enterprise 11 использует команду Извлечь поля формы и сохраняет значения в Credential
Vault, то в процессе миграции эти значения переносятся в Credential Vault Automation 360.
The output of an Enterprise 11 бот is mapped with multiple variables in the equivalent actions of the PDF
пакет after that бот is migrated to Automation 360. This reduces the number of actions in the migrated
бот because a separate action is no longer required to map output to a variable.
См. раздел PDF пакет on page 1747.

PGP

Все команды PGP переносятся в эквивалентные действия Automation 360 пакета PGP. Изменения в
поведении или имени команды отсутствуют.
См. раздел PGP пакет on page 1755.

Воспроизвести звук

Все команды «Воспроизвести звук» переносятся в эквивалентные действия пакета Звук в
Automation 360.
Automation 360 поддерживает только следующие типы файлов в действии «Воспроизвести
медиафайл»: .mp3 и .wav.
См. раздел Play Sound package on page 1758.

Принтер

Принтер по умолчанию, Удалить принтер и Выбрать принтер по умолчанию переносятся в
эквивалентные действия пакета Принтер в Automation 360.
См. раздел Принтер пакет on page 1758.

Запрос

Все команды Запрос переносятся в эквивалентные действия пакета Запрос в Automation 360.
В следующей таблице показаны команды, которые могут быть перенесены с изменением имени.
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Команды Enterprise 11 или Enterprise 10 Эквивалентные пакеты и actions Automation
360

Запрос значения Преобразуется в действие Для значения.
Кроме того, действие Имитировать
нажатия клавиш добавляется ниже
действия Для значения для выполнения
нажатий клавиш на определенном заголовке
окна. Это делается для того, чтобы сохранить
поведение при выполнении старых боты.

Запрос файла Для файла

Запрос папки Для папки

Запрос «Да/Нет» Запрос «Да/нет»

См. раздел Запрос пакет on page 1760.

Read from CSV/Text

Прочитать из CSV/текста преобразуется в действия Открыть, Чтение и Закрыть в пакете
CSV/TXT Automation 360.
Если бот Enterprise 10/Enterprise 11 использует переменную в качестве имени сеанса, а действие
Цикл, применяемое для чтения всех строк из файла CSV/TXT, использует жестко заданное имя
сеанса вместо переменной, необходимо проверить перенесенный бот и установить выходную
переменную для действия CSV/TXT > Чтение в соответствующем цикле. В противном случае вы
получите ошибку пользовательского интерфейса при редактировании бот Automation 360.
Если файл CSV/TXT отсутствует по указанному пути к файлу в Automation 360, бот возвращает
сообщение об ошибке, в то время как в Enterprise 11 бот не возвращает такого сообщения.

Important:  Проверьте перенесенный бот и установите выходную переменную для действия CSV/
TXT > Чтение в соответствующем цикле.

Веб-служба REST

Параметр Сохранить заголовок в в Enterprise 11 переносится в Automation 360. Этот параметр
позволяет хранить заголовок ответа в переменных типа «Массив» и «Словарь» с именем заголовка
ответа в качестве ключа и значением заголовка в качестве значения словаря.
В Enterprise 11 ответ на сбой фиксируется по умолчанию. В Automation 360 при включении
параметра Сделать снимок ответа на сбой ошибки фиксируются и добавляются в переменную
словаря ответов. При переносе бот Enterprise 11 в Automation 360 параметр Сделать снимок
ответа на сбой включен по умолчанию для записи ответа на сбой перенесенного бот.
The time-out value configured in Enterprise 11 to send REST request is migrated to Automation 360 as
part of global values (AARestTimeOut). The default time-out value is set as 60000 ms in Automation 360.
You can update this value if the Веб-служба REST is taking more time to receive a response.
См. раздел Веб-служба REST пакет on page 1793.
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Запустить логику

Команда Запустить логику переносится в действие Запустить пакета Task Bot в Automation 360.
Кроме того, команды Обработка ошибок и Запустить логику переносятся в блок Попробовать
и выявить.
• Применяется с версии 25:боты Enterprise 11 или Enterprise 10, которые используют команду

Запустить логику, переносятся, если переименовывается связанная Логика MetaBot или
изменился относительный путь после сопоставления. Если Логика MetaBot переименована или
изменен путь после сопоставления в TaskBots, то теперь миграция TaskBots выполняется с
новым именем или путем Логика MetaBot.
Изменение относительного пути применимо в следующих сценариях.
• Логика перемещается из одной папки в другую.
• Логика перемещается из папки корневого уровня MetaBot в подпапку.
• Логика перемещается из подпапки в папку корневого уровня MetaBot.
• Папка, в которой находится Логика, переименовывается.

• Боты, использующие команду Запустить логику, которая передает атрибуты Credential Vault из
TaskBot в логику MetaBot, могут быть перенесены в Automation 360. Имя учетных данных и имя
атрибута отображаются в полях в соответствующей строке перенесенного бот.

• Если вы выполнили миграцию с использованием восстановленной базы данных Enterprise
11, эквивалент ячейка будет создан в Automation 360 для переменных учетных данных,
используемых в бот Enterprise 11.

• Применяется с версии 23. боты Enterprise 11 или Enterprise 10, которые используют команду
Запустить логику, могут передавать переменные типа Credential Vault из родительского бот
переменной MetaBot, не относящейся к типу «Компонент учетных данных». Однако в Automation
360 переменные Credential Vault передаются только переменным типа «Компонент учетных
данных» (а не переменной, не относящейся к типу «Компонент учетных данных) для повышения
уровня безопасности. Поэтому в процессе миграции переменная типа Credential Vault сначала
преобразуется в переменную строкового типа с помощью действия Преобразовать компонент
учетных данных в строку из пакета «Компонент учетных данных», чтобы перенесенный
бот можно было успешно запустить. Затем строковая переменная присваивается временной
переменной, которая используется в качестве входного параметра в действии Задача >
Запустить для вызова Логика MetaBot.

• Боты, которые используют переменные Credential Vault, передаются от одной Логика MetaBot к
другой Логика MetaBot для команды Начать обработку ошибок >  Запустить логику.

• Когда вы выполняете команду Начать обработку ошибок > Запустить логику, вы можете
выполнить миграцию MetaBot с Логика (родительской), которая содержит переименованную
Логика (дочернюю). Если дочерняя Логика переименовывается после ее сопоставления с
родительской Логика, то это сопоставление родительской Логика переносится с новым именем.

Выберите один из следующих вариантов, чтобы успешно запустить перенесенные боты.
• Вариант 1. Передайте переменные типа «Компонент учетных данных».

1. Создайте переменную типа «Компонент учетных данных» в дочерних боты в качестве
входной переменной.

2. В action Запустить в пакет TaskBot родительского бот обновите поля входных значений,
чтобы использовать атрибуты Credential Vault для переменной типа учетных данных,
созданной для дочернего бот (в соответствии с логикой MetaBot).
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• Вариант 2. Передайте значения учетных данных в качестве глобального значения.
1. Создайте глобальное значение в Automation 360 для учетных данных, используемых в

команде Запустить логику в Enterprise 11.
2. В action Запустить в пакет TaskBot родительского бот обновите поля входных значений,

чтобы использовать глобальные значения для переменной типа учетных данных, созданной
для дочернего бот (в соответствии с логикой MetaBot).

Если вы не использовали восстановленную базу данных Enterprise 11 при установке Automation 360,
перед выполнением шагов, представленных выше, вам потребуется создать необходимую ячейку
для переменных учетных данных, используемых в бот Enterprise 11.

Note:  Automation 360 обеспечивает повышенный уровень безопасности, позволяя присваивать
атрибуты Credential Vault только переменным типа учетных данных. Это ограничивает любую
небезопасную работу с атрибутами Credential Vault, если они присвоены переменным типа не
учетных данных.

Run Script

Команда Запустить сценарий переносится в действие Запустить сценарий пакета
Автоматизация предыдущих версий.
Когда вы используете пакет Автоматизация предыдущих версий с действием Запустить
сценарий после миграции, вы можете столкнуться с проблемами при использовании некоторых
сценариев, поэтому ознакомьтесь с причинами и способами их устранения.
• Причина. Если в поле Действие «Запустить сценарий» > Входные параметры в конце

значения аргумента (переданного с помощью Строка > Действие «Присвоить») содержатся
двойные кавычки и обратная косая черта, а значение переменной содержит пробел, строка
разрывается в месте первого пробела (это связано с изменениями при обновлении openJDK).

• Пример. Рассмотрите путь к папке в качестве значения аргумента, который передается с
использованием раздела Строка > Действие «Присвоить», "\\fwus129ns.ny.fw.gs.com\mahatb
\home\My Documents\Test Adhoc Request\". Когда вы перенесете этот бот Enterprise 11 в Automation
360, это значение аргумента будет определено как четыре разных значения аргумента в
Automation 360, как показано ниже.
• \\fwus129ns.ny.fw.gs.com\mahatb\home\My
• Documents\Test
• Adhoc
• Request\

• Решение. Отредактируйте бот Enterprise 11 и удалите двойные кавычки в значении переменной
в разделе Строка > Действие «Присвоить».

SAP Integration

Эта команда переносится в пакет Средство записи > action Запись в Automation 360. Все свойства
объекта в боты Enterprise 11 сопоставляются с эквивалентными свойствами в перенесенных боты.

Note:  Если бот Enterprise 11 с командой SAP Integration использует SAP GUI 740 или более
раннюю версию, выполните дополнительные действия на компьютере Bot Agent, чтобы успешно
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запустить перенесенный бот в Automation 360. Подробнее см. в разделе Failed to capture SAP
application using SAP GUI 740 (A-People login required).

If you run migrated боты with the SAP GUI option selected but the SAP GUI window is closed, an
exception error is displayed. This occurs because, the Средство записи package uses the Window title
during runtime and, in Automation 360, SAP Integration is migrated to Средство записи package.
В следующей таблице приведен список объектов и действий SAP, которые можно перенести в
Automation 360.

Объект Действие

Текстовое поле «Установить текст», «Добавить текст»,
«Левый щелчок», «Правый щелчок»,
«Двойной щелчок»

Поле со списком «Выбрать элемент по тексту», «Выбрать
элемент по индексу», «Получить общее число
элементов», «Получить текст выбранного
элемента», «Получить ключ выбранного
элемента», «Получить свойство», «Настроить
фокус», «Левый щелчок», «Правый щелчок»,
«Двойной щелчок»

Флажок «Установить», «Снять», «Переключить»,
«Получить состояние», «Получить свойство»,
«Настроить фокус», «Левый щелчок»,
«Правый щелчок», «Двойной щелчок»

Кнопка «Щелчок», «Получить свойство», «Левый
щелчок», «Правый щелчок», «Двойной
щелчок»

Переключатель «Выбрать», «Получить состояние», «Получить
свойство», «Настроить фокус», «Левый
щелчок», «Правый щелчок», «Двойной
щелчок»

Строка меню «Выбрать элемент по тексту», «Получить
свойство», «Настроить фокус», «Левый
щелчок», «Правый щелчок», «Двойной
щелчок»

Дерево «Получить свойство», «Настроить фокус»,
«Левый щелчок», «Правый щелчок»,
«Двойной щелчок», «Получить общее число
элементов», «Получить выбранный индекс»,
«Получить выбранный текст», «Выбрать
элемент по индексу», «Выбрать элемент по
тексту»

Метка «Щелчок», «Получить свойство», «Настроить
фокус», «Левый щелчок», «Правый щелчок»,
«Двойной щелчок»
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Объект Действие

Табуляция «Получить свойство», «Настроить фокус»,
«Левый щелчок», «Правый щелчок»,
«Двойной щелчок», «Получить общее число
элементов», «Получить выбранный индекс»,
«Получить выбранный текст», «Выбрать
элемент по индексу», «Выбрать элемент по
тексту»

Остальные элементы управления
(Включают в себя такие элементы
управления, как GuiMainWindow,
GuiBox, GuiUserArea, GuiTitlebar и
GuiStatusbar)

«Получить свойство», «Настроить фокус»,
«Левый щелчок», «Правый щелчок»,
«Двойной щелчок»

В следующей таблице показаны actions, выполняемые в объекте главного окна, и эквивалентные им
actions в Automation 360.

Enterprise 11 action Эквивалентное action Automation 360

Активировать окно action Активировать из пакет Окно.

Закрыть окно action Закрыть из пакет Окно.

Выполнить сценарий actions Добавить сеанс SAP и Выполнить
функцию из пакет Legacy Automation.

Развернуть окно action Развернуть из пакет Окно

Восстановить окно action Восстановить из пакет Окно

Команды SAP, поддерживающие функции BAPI в Enterprise 11, переносятся в эквивалентные
действия пакет SAP BAPI в Automation 360.
В следующей таблице показана команда Enterprise 11 и эквивалентное ей действие в Automation
360.

Команда Enterprise 11 Действие Automation 360

Подключить SAP BAPI > Подключить
Вы должны создать глобальные значения
JcoDllPath и JcoJarPath. В глобальное
значение JcoJarPath добавьте расположение
пакета соединителей SAP Java, а в значение
JcoDllPath — расположение DLL соединителя
SAP Java.

Создать функцию SAP BAPI > Создать функцию

Команда «Получить данные» с выбранным
параметром Поле

SAP BAPI > Получить поле

Команда «Получить данные» с выбранным
параметром Таблица

SAP BAPI > Получить таблицу

Команда «Получить данные» с выбранным
параметром Структура

SAP BAPI > Получить структуру
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Команда Enterprise 11 Действие Automation 360

Команда «Установить данные» с выбранным
параметром Поля, Таблица или Структура

SAP BAPI > Установить поле

Вызвать функцию SAP BAPI > Выполнить функцию

Запустить стандартный рабочий процесс SAP BAPI > Запустить стандартный
рабочий процесс

Запустить настраиваемый рабочий процесс SAP BAPI > Запустить настраиваемый
рабочий процесс

Отправить сообщение эл. почты

В Enterprise 10/Enterprise 11 команда «Отправить сообщение электронной почты» использует
определяемые пользователем настройки электронной почты, которые хранятся в виде атрибутов
учетных данных в системной ячейке. При переносе первого бот создается пользовательская ячейка
под названием AAE_Email. В нее добавляются учетные данные AAE_EmailSettings с атрибутами
имени пользователя и пароля. Кроме того, создаются глобальные значения для атрибутов, не
относящихся к учетным данным, таких как узел сервера, порт, SSL и аутентификация, которые
соответствуют тем же настройкам электронной почты. Учетные данные настроек электронной
почты Enterprise 10/Enterprise 11 разделены на переменные учетных данных и глобальные значения
в Automation 360, поэтому в процессе миграции параметры электронной почты переносятся
следующим образом.

Настройки электронной
почты Enterprise
10/Enterprise 11

Настройки электронной
почты Automation 360

Тип хранения Automation 360

Узел Глобальное значение
типа «Строка»
AAE_EmailSettings_host

Порт Глобальное значение
типа «Число»
AAE_EmailSettings_port

Использовать безопасное
подключение (SSL/TLS)

Глобальное значение
типа «Логический»
AAE_EmailSettings_ssl

На сервере требуется
проверка подлинности

Глобальное значение
типа «Логический»
AAE_EmailSettings_auth

Имя пользователя Атрибут учетных данных
userName в учетных данных
AAE_EmailSettings,
назначенных ячейке
AAE_Email

Пароль Атрибут учетных данных
password в учетных данных
AAE_EmailSettings,
назначенных ячейке
AAE_Email
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Службы

Все команды Службы переносятся в эквивалентные действия пакета Служба в Automation 360.
Изменения в поведении или имени команды отсутствуют.

Веб-служба SOAP

Поведение этого пакета идентично его поведению в Automation 360.
Если веб-служба SOAP настроена на вызов REST API, она переносится в действие веб-службы REST
вместо действия веб-службы SOAP. Основываясь на дополнительных операциях XML, мы добавляем
действия из пакета XML, чтобы убедиться, что перенесенный бот воспроизводит тот же результат,
что и устаревший бот.
The time-out value configured in Enterprise 11 to send SOAP request is migrated to Automation 360 as
part of global values (AASoapTimeOut). The default time-out value is set as 60000 ms in Automation 360.
You can update this value if the Веб-служба SOAP is taking more time to receive a response.

Пример использования действия веб-службы SOAP on page 2090
В Enterprise 11 имеется возможность выбора Типа URI для выполнения, например По
умолчанию, Статический и Динамический. Однако в Automation 360 нельзя выбрать тип URI
для выполнения. Типы URI Enterprise 11 переносятся в Automation 360 следующим образом.
• По умолчанию и статические. Если для бот Enterprise 11 указан тип URI По умолчанию

или Статический, бот переносится в виде статического, и поле Расположение адреса
заполняется автоматически.

• Динамические. Если для бот Enterprise 11 указан тип URI Динамический, бот переносится в
виде динамического, и поле Расположение адреса остается пустым.

См. раздел Веб-служба SOAP пакет on page 1894.

Операция строки

Команда Операция строки в Enterprise 11 или Enterprise 10 переносится в эквивалентные actions
пакет Строка.
В следующей таблице показаны команды Операция строки и эквивалентные им actions в Automation
360.

Команды Enterprise 11 или Enterprise 10 Эквивалентные пакеты и actions Automation
360

До и после Извлечение

Сравнить Сравнить

Найти Найти

Длина Длина

Нижний регистр Нижний регистр

Заменить Заменить

Обратный порядок Обратный порядок

Разделить Разделить

Подстрока Подстрока
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Команды Enterprise 11 или Enterprise 10 Эквивалентные пакеты и actions Automation
360

Обрезать Обрезать

Верхний регистр Верхний регистр

In Enterprise 11, both carriage return (CR) and newline (LF) were enumerated to calculate the total
length of Операция строки. However, in Automation 360, only newline (LF) is considered for the length of
Операция строки. Hence, the length count in the resulting output in Automation 360 is lesser.
боты Enterprise 11 могут использовать регулярные выражения в командах Найти и Заменить для
поиска строки, с которой нужно выполнить операцию. Эквивалентные actions в Automation 360
также могут использовать регулярные выражения для поиска строки, с которой нужно выполнить
операцию.
В Enterprise 11 система учитывает символ новой строки (/n), используемый в переменной, когда вы
используете команды Найти и Заменить. Однако в Automation 360 система не учитывает символ
новой строки при использовании команд Найти и Заменить.
Когда вы переносите бот в Automation 360, а для операции строки установлено действие До или
После, выходные данные извлекаются правильно, и операция проходит успешно. Совпадающие
выходные данные отображаются, даже если перед совпадающей строкой нет ни одного символа. В
Enterprise 11 боты с действиями До или После извлекают выходные данные некорректно и поэтому
извлекают саму исходную строку. Если перед совпадающей строкой нет ни одного символа, в
выходных данных будет указано, что совпадений не найдено.
Пример.
Drag Before/After Action → (Inputs : [Source = (ABCZ)] → [Before = Z] →
[assign to Prompt-assign] → Output : Empty("")

Drag Before/After Action → (Inputs : [Source = (ZABC)] → [After = Z] → [assign
to Prompt-assign] → Output : ZABC

Система

Действия Заблокировать компьютер, Завершить сеанс, Перезагрузка и Завершение
работы переносятся в эквивалентные действия пакета Система в Automation 360.
См. раздел Система пакет on page 1905.

Задача

В следующей таблице показаны различные команды, которые переносятся в соответствующие
действия в пакет TaskBot в Automation 360.

Команды Enterprise 11 или
Enterprise 10

Эквивалентные пакеты и actions Automation 360

Приостановить Приостановить

Остановить задачу Остановить

Выполнить задачу Запустить. Выходные данные, возвращаемые дочерними
боты, сопоставляются с соответствующей переменной в
родительских боты.
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Эмулятор терминала

Шифрование текста не поддерживается действиями Отправить текст и Установить поле для
Automation 360. Рекомендуется использовать Credential Vault вместо обычного текста.
В Enterprise 11 и Automation 360:
• Боты, которые используют следующую модель терминала, могут быть перенесены в Automation

360:
• Модель VT 220 терминала серии VT
• Модели IBM 5555 B01 и C01 типа терминала TN 5250

• Сеанс (используемый для подключения к серверу терминалов) может быть общим для
родительского бот и дочернего бот. Вы можете закрыть сеанс из дочернего бот вместо того,
чтобы закрывать его из родительского бот.

• Вы можете использовать терминал По умолчанию в боты для типа терминала VT100.
• Боты, которые отправляют текст на японском языке с помощью команды Отправить текст в

Enterprise 11, параметра DBCS из списка Кодировка и параметра Японский Shift-JIS (932)
из списка CodePage, выбранных в команде Подключить, могут быть перенесены в Automation
360.

• Applies only to v.24 and earlier: Когда в Эмулятор терминала вы вручную щелкаете по клавише
на клавиатуре, в Enterprise 11 главная клавиша Enter обозначается как {enter}, а в Automation
360 она обозначается как {return}.

Automation 360 не поддерживает устаревшие технологии и по умолчанию поддерживает все
возможности «Расширенной технологии» боты Enterprise 10/Enterprise 11.
Максимальное значение индекса в Automation 360 — 99 999. В процессе миграции значение Индекс
поля в действии Установить поле автоматически изменяется на «99 999» в соответствии с
ограничением для максимального значения. Если значение индекса больше 99 999 и используется в
переменной, его необходимо изменить вручную.
Функция SSHI пока не поддерживается в Automation 360.
Действие Поиск поля позволяет выполнять поиск индекса или имени поля, используя текст.
Для Боты, созданных в Enterprise 11, больше не отображается текст Попытка... после миграции
боты в Automation 360.
См. раздел Terminal Emulator пакет on page 1916.

Операция переменной

Ниже перечислены операции, при которых значение присваивается переменной.

Переменные типа значения Функциональные возможности этой команды
разделены на несколько пакетов в Automation
360.
В Enterprise 10/Enterprise 11 эта команда
выполняла операции присвоения для всех
поддерживаемых типов данных. В Automation
360 создано специальное действие Присвоить
для каждого типа данных. В процессе миграции
сопоставление исправленных пакетов и
действий обрабатывается на основе присвоения,
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которое выполняет соответствующая операция
переменной.
Для боты Enterprise 11, которые используют
параметр Десятичная конфигурация,
action В строку из пакет Число добавляется
в перенесенные боты. В Enterprise 11
система округляет значение, основываясь
на значении, указанном в поле Десятичная
конфигурация. Например, если значение,
которое присваивается переменной, равно
13,456, а значение, указанное в конфигурации
Десятичная конфигурация — 2, система
округляет значение в Enterprise 11 до 13,46.
В Automation 360 значение обрезается, а не
округляется. Например, значение 13,456 в
Automation 360 будет преобразовано в 13,45.

Переменные типа списка Операции, связанные с назначениями
списка, переносятся в раздел Установить
элемент пакета Список. Если операция имеет
фиксированное значение, система создает
временную переменную и сохраняет в ней
фиксированное значение. Затем вы можете
использовать эту временную переменную в
действии Присвоить пакета Список для ее
сохранения.

Переменные типа массива Операции, связанные с присвоением массива,
переносятся в действие Установить значение
одной ячейки пакета Datatable для установки
значения определенных строк и столбцов.

Переменные типа словаря Операции, связанные с присвоением
словаря, переносятся в действие Вставить
пакета Словарь для установки значения
для определенного ключа. Если ключ
представляет собой комбинацию переменной
и фиксированного значения (например,
$Dictionary(key-$id$)$), то для получения
фактического ключа добавляется пакет
Строка > действие Присвоить.

Системная переменная $Date$ Команда «Операция переменной» в Enterprise
10/Enterprise 11, которая использует системную
переменную $Date$, переносится в Automation
360 путем добавления новых действий с
датой на основе операции, выполняемой с
использованием $Date$. В процессе миграции
значение даты также преобразуется в строковый
формат по умолчанию: mm/dd/yyyy HH:mm:ss.
Случайная переменная подтипа «Строка».
Мы выполняем перенос и сопоставление
напрямую.
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Ниже перечислены операции с переменными, при использовании которых значение переменной
инициализируется повторно.

Переменная списка Для команды Операции переменной, которая
повторно инициализирует переменную списка в
Enterprise 10/Enterprise 11, в процессе миграции
создается временная переменная списка с
новыми значениями, которая присваивается
целевой переменной списка в Automation 360.

Переменная списка, объявляемая при
чтении текстового файла

Эта команда перенесена в action
Импортировать список из текстового
файла в пакет Автоматизация предыдущих
версий.

Note:  В Automation 360 возникает ошибка
бот, если исходный файл пуст или не содержит
ключа для инициализации переменной списка, в
отличии от Enterprise 10 или Enterprise 11.

Переменная массива, объявляемая при
чтении текстового файла

Тип переменной «Массив» переносится в виде
типа переменной «Таблица» в Automation
360. Система использует пакет CSV/TXT для
чтения и загрузки соответствующих данных в
переменную таблицы в бот.

Переменная словаря В процессе миграции создается временная
переменная словаря для хранения всех ключей
и значений. Затем система использует пакет
Словарь > действие Присвоить для изменения
целевой переменной с помощью ключей и
значений из временной переменной словаря.

Переменная словаря, объявляемая при
чтении текстового файла

В процессе миграции эта проблема решается
путем добавления действий для чтения
CSV-файла с помощью пакета CSV/текст и
сохранения данных в переменной таблицы.
Затем добавляются действия для выполнения
цикла с переменной таблицы, и используется
пакет Словарь > действие Вставить для
добавления ключей и значений в переменную
словаря.

Переменная массива, объявляемая при
чтении файла Excel/CSV

В процессе миграции эта ситуация решается
путем переноса типа переменной «Массив»
в тип переменной «Таблица» в Automation
360. Система добавляет действия Открыть,
Получить несколько ячеек и Закрыть из
пакета Расширенный Excel и заполняет
переменную таблицы.

Ниже перечислены операции с переменными, при использовании которых выполняется сброс
значения системной переменной.

Операция переменной (сброс системных
переменных)

Следующие системные переменные переносятся
в Automation 360 в виде переменных,
определяемых пользователем. Система
добавляет соответствующее действие для
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удаления значения эквивалентной переменной,
созданной в Automation 360.
• Копия сообщения эл. почты
• Сообщение эл. почты от
• Сообщение эл. почты
• Дата получения сообщения эл. почты
• Время получения сообщения эл. почты
• Тема сообщения эл. почты
• Сообщение эл. почты по адресу
• Описание ошибки
• Номер строки ошибки

Ожидать

Ожидать окно и Ожидать изменения экрана в Automation 360 выдают ошибку исключения,
если соответствующее окно закрывается/не открывается в указанное время или экран не удается
найти в указанное время. В этих случаях система добавляет блок «Попробовать и выявить», если
команда настроена на остановку бот и добавляет действие Остановить задачу в блоке «Выявить».
Это необходимо для гарантии того, что поведение перенесенных боты при выполнении будет таким
же, как в Enterprise 10/Enterprise 11.
Поскольку команды переносятся с помощью действия Остановить бот из блока «Попробовать
и выявить» в Automation 360, бот также останавливается, если действие не выполняется по
какой-либо другой причине. Во время процесса миграции действие Остановить бот также
добавляет дополнительные обработчики ошибок в перенесенный боты при выборе параметра
Остановить задачу.
Действие Ожидать окна может иметь отрицательные значения для координат, которые не
поддерживаются в Automation 360. Отрицательные значения изменяются на «0» в процессе
миграции.

Средство веб-записи

Все команды (кроме тех, которые явно упомянуты ниже) из Средства веб-записи переносятся
в соответствующие действия в пакет Автоматизация предыдущих версий в Automation 360.
Пакет Автоматизация предыдущих версий гарантирует, что перенесенные боты воспроизводят
тот же результат, что и в Enterprise 10/Enterprise 11. Однако не рекомендуется использовать пакет
Автоматизация предыдущих версий для новых разработок.
Найти неработающие ссылки переносится в пакет Браузер > Найти неработающие
ссылки. Кроме того, в Enterprise 10/Enterprise 11 в меню «Инструменты > Параметры» есть
параметры «Время ожидания для поиска неработающих ссылок» и «Найти неработающие ссылки».
В Automation 360 эти параметры входят в состав действия, время ожидания по умолчанию равно
10 секундам, а число параллельных потоков по умолчанию равно 10.
Загрузить файлы переносится в пакет Браузер > Загрузить файлы.
Во время процесса миграции действие Извлечь таблицу добавляет дополнительные обработчики
ошибок в перенесенные боты, когда установлен флажок При ошибке выполнить следующее
действие.
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Действие окна

Все команды из Windows Actions переносятся в эквивалентные им actions из пакет Окно в Automation
360.
боты Enterprise 11 могут использовать регулярные выражения в командах Получить заголовок
активного окна, Активировать окно, Развернуть окно, Свернуть окно, Закрыть окно и
Изменить размер окна для поиска окна, с которым нужно выполнить операцию. Эквивалентные
actions в Automation 360 также могут использовать регулярные выражения для поиска окна, с
которым нужно выполнить операцию.
См. раздел Окно пакет on page 1943.

XML

Все команды XML переносятся в эквивалентные действия пакета XML в Automation 360.
Следующие имена команд изменились.

Enterprise 10/Enterprise 11 Automation 360

Завершить сеанс XML Завершить сеанс

Начать сеанс XML Начать сеанс

Удалить узел/атрибут Удалить узел

Обновить узел/атрибут Обновить узел

Действие «Получить узлы» с выбранным параметром
«Одинарные узлы»

Действие «Получить один узел»

Действие «Получить узлы» с выбранным параметром
«Несколько узлов»

Действие «Получить несколько узлов»

В Enterprise 11, когда вы устанавливаете для команды XML значение Получить узлы с выбранным
параметром Несколько узлов, Выражение XPath возвращает только последний элемент
совпадающего выражения. В Automation 360 Выражение XPath возвращает все совпадающие
элементы.
боты Enterprise 11, которые извлекают узлы, содержащие пространства имен, из XML-файла, можно
перенести в Automation 360. После добавления пространства имен к узлу в XML-файле, чтобы
отразились изменения, необходимо сохранить и перезагрузить XML-файл.
См. раздел XML package on page 1953.

Сопоставление переменных для миграции
При миграции некоторые переменные из предыдущих версий продукта напрямую сопоставляются
с Automation 360, в то время как другие переменные ведут себя иначе или имеют измененную
конфигурацию.

Note:  In Enterprise 11, if a бот used a variable that was followed by a space and a string that began with
a dollar sign character ($) and enclosed in parentheses, brackets, or braces, after migration, the variable
field encounters an error. The error occurs because, in Automation 360, two dollar sign characters ($$)
are required in a string to display the dollar sign. To fix this error, add another dollar sign to the string. For
example, if you are using the prompt-assignment variable to display a string followed by $5 [$Prompt-
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Assignment$ ($5)], after migration, the variable field displays an error. To fix the error, edit the variable
field to add another dollar sign, as follows: [$Prompt-Assignment$ ($$5)].

Переменные, определенные пользователем

В Automation 360 все переменные, определенные в боты, создаются с типами Использовать
как вход и Использовать как выход во время миграции для обмена значениями между
родительскими боты и дочерними боты.
Если переменные сопоставлены между родительским бот и дочерним бот в Enterprise 11 и некоторые
из сопоставленных переменных недоступны ни в родительском бот, ни в дочернем бот, в процессе
миграции эти переменные удаляются. В процессе миграции такие переменные удаляются для
дочерних боты, которые переносятся вместе с родительскими боты, и для дочерних боты, которые
уже перенесены.
For information about the list of variables supported, see Поддержка переменных on page 736.
Узнайте, как переносятся следующие переменные, определенные пользователем.
• Массив
• Словарь
• Список
• Случайная
• Значение

Массив
В этом разделе объясняется, как переменная Массив переносится в Automation 360. В некоторых
случаях вам может потребоваться выполнить некоторые действия или обеспечить определенные
условия до или после миграции.

Подтип «Значение» Переменные с этим подтипом переносятся в
Таблицу со всеми значениями столбцов в виде
Строк.

Подтип «Прочитать из текстового файла» Переменные с этим подтипом переносятся в
Таблицу со всеми значениями столбцов в виде
Строк.
Следующие действия добавляются в рамках
миграции для настройки данных в переменной.

Действия Automation
360

Функция

CSV/TXT > Открыть Открывает файл для
чтения.

CSV/TXT > Чтение Возвращает значение
в переменной
таблицы.

CSV/TXT > Закрыть Закрывает файл.

Подтип «Прочитать из базы данных» Переменные с этим подтипом переносятся в
пакет Таблица со всеми значениями столбцов в
виде Строк.
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Следующие действия добавляются в рамках
миграции для настройки данных в переменной.

Действия Automation
360

Функция

База данных >
Подключить

Добавляет действие
Подключить с
соответствующей
строкой подключения.

База данных >
Экспортировать в
таблицу данных

Добавляет действие
Экспортировать в
таблицу данных для
возврата результатов
в переменную
таблицы данных.

База данных >
Отключить

Добавляет действие
Отключить для
отключения базы
данных.

См. также: База данных пакет on page 1463.

Подтип «Прочитать из файла Excel/CSV» Переменные с этим подтипом переносятся в
Таблицу со всеми значениями столбцов в виде
Строк.
Следующие действия добавляются в рамках
миграции для настройки данных в переменной.

Действия Automation
360

Функция

Расширенный Excel
> Открыть

Открывает файл для
чтения.

Расширенный
Excel > Получить
несколько ячеек

Возвращает значение
переменной
Таблица, если
параметр Все ячейки
или Диапазон
выбран в описании
переменной.

Расширенный Excel
> Читать сейчас

Возвращает значение
переменной
Таблица, если
параметр Вся строка
выбран в описании
переменной.
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Действия Automation
360

Функция

Расширенный
Excel > Прочитать
столбец

Возвращает
переменную
Таблица, если
параметр Весь
столбец выбран в
описании переменной.
Кроме того, пакет
Присвоить список
таблице данных
списка используется
для сохранения
возвращаемого
значения в
переменную.

Расширенный Excel
> Закрыть

Закрывает файл.

Important:  В Automation 360 пустая
переменная таблицы возвращает ошибку
времени выполнения. Если перенесенный бот
содержит пустую переменную таблицы, эту
проблему необходимо решить в Automation 360.

Переменная массива. Типы входных
данных, принимаемые функцией DLL

Когда система передает переменную массива
из бот Enterprise 11 в функцию DLL другого
типа, функция DLL принимает следующие типы
входных данных:
• UInt16[], Int16[], Int32[], Int64[], Int[], Char[],

Single[], Decimal[], Float[], Double[], Boolean[],
bool[], Byte[], String[] и Datetime[]

• UInt16, Int16, Int32, Int64, Int, Char, Single,
Decimal, Float, Double, Boolean, bool, Byte,
String и Datetime

• List<UInt16>, List<Int16>, List<Int32>,
List<Int64>, List<Int>, List<Char>,
List<Single>, List<Decimal>, List<Float>,
List<Double>List<Boolean>, List<bool>,
List<Byte>, List<String>, List<Date-Time>

• UInt16[,], Int16[,], Int32[,], Int64[,], Int[,],
Char[,], Single[,], Decimal[,], Float[,], Double[,],
Boolean[,], bool[,], Byte[,], String[,] и
Datetime[,]

Дополнительная информация Вы можете перенести боты Enterprise 10
или Enterprise 11, которые включают в себя
переменные массива.
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Ниже перечислены некоторые ключевые
различия в поведении.
• Позиция индекса начинается с «1» в

Enterprise 10 и Enterprise 11, в то время как в
Automation 360 позиция индекса начинается
с «0». For example, $arrayVariable(1,1)$
becomes $arrayVariable[0][0]$

• Если в массиве содержится 10 строк/столбцов
и цикл выполняется более 10 раз, то
Enterprise 10/Enterprise 11 возвращает имя
переменной массива с позицией индекса.

• In Enterprise 11, if you pass a constant string
value to an array index in any command (for
example $array(field1), where field1 is not
a variable), the value is used as is (for example,
$array(field1)). Однако после переноса
бот в Automation 360 возникает ошибка
времени компиляции, если команда имеет
фиксированное значение.

• In Enterprise 11, if you pass an array variable
without any index (for example "$array$",
"$array()$", where index is missing), the
value is used as is (for example, "$array$",
 "$array()$"). Однако после переноса бота
в Automation 360 возникает ошибка времени
компиляции.

Important:  Если для доступа к массивам в
Enterprise 11 используется недопустимый индекс,
убедитесь, что ошибка бот устранена до или
после миграции.

Словарь
В этом разделе объясняется, как переменная Словарь переносится в Automation 360. В некоторых
случаях вам может потребоваться выполнить некоторые действия или обеспечить определенные
условия до или после миграции.

Запустить логику In Enterprise 11, when you perform a Run Logic
operation, you can select a specific key from the
Словарь variable and map it to the required value
variable.
In Automation 360, you can only map variables
directly and cannot map a Словарь(key) variable to
a string.

Подтип «Значение» Система переносит эти переменные в тип
Словарь с подтипом Строка в Automation 360.

Подтип «Прочитать из файла CSV» В процессе миграции действия для чтения
CSV-файла добавляются с помощью пакета
CSV/текст, а данные сохраняются в
переменной таблицы. В процессе также
добавляются действия для выполнения цикла с
переменной Таблица и используется действие
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«Вставить» пакета Словарь для добавления
ключа и значений в переменную Словарь.

Переменная словаря. Типы входных
данных, принимаемые функцией DLL

Когда система передает переменную словаря
из бот Enterprise 11 в функцию DLL другого
типа, функция DLL принимает в качестве типов
входных данных следующие. UInt16, Int16, Int32,
Int64, Int, Char, Single, Decimal, Float, Double,
Boolean, bool, Byte, String и Datetime.

Дополнительная информация Вы можете перенести боты Enterprise 10
или Enterprise 11, которые включают в себя
переменные словаря.
В следующей таблице описаны некоторые
ключевые различия в поведении и процесс
работы в Automation 360.

Поведение Enterprise
10 или Enterprise 11

Поведение
Automation 360

Ключи словаря
заполняются без
учета регистра в
Enterprise 10 или
Enterprise 11.

Ключи словаря
заполняются с учетом
регистра в Automation
360.
Для сохранения
устойчивости
выполнения бот в
процессе миграции
все значения
ключей словаря
преобразуются
в значения в
нижнем регистре.
Выражение строки
Нижний регистр
используется,
если переменная
используется в
качестве ключа
словаря для
получения имени
ключа в нижнем
регистре.

Список
В этом разделе объясняется, как Список переносится в Automation 360. В некоторых случаях вам
может потребоваться выполнить некоторые действия или обеспечить определенные условия до или
после миграции.

Подтип «Значение» Эти переменные переносятся в Список с
подтипом Строка.

Подтип «Массив» Эти переменные переносятся в Список с
подтипом Строка.
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Подтип «Чтение из текстового файла» Когда вызывается переменная, объявляемая
при чтении файла, над переносимым действием
добавляется действие Импортировать список
из текстового файла пакета Автоматизация
предыдущих версий.

Объявлено как «Сделать случайным» Переменная Список может быть объявлена
как Сделать случайным в Enterprise 10
или Enterprise 11 для возврата случайного
элемента из списка. В процессе миграции новое
действие Размер добавляется в пакет Список
для получения размера списка, а действие
Присвоить случайное число добавляется в
пакет Число, чтобы найти случайную позицию
и использовать ее для получения случайного
элемента списка.

Important:  В Automation 360 пустая
переменная списка, используемая вне цикла,
возвращает ошибку времени выполнения.
Если перенесенный бот соответствует этому
критерию, вы должны решить проблему в среде
Automation 360.

Дополнительная информация • В Enterprise 10 и Enterprise 11 Список
доступен без указания индекса. В Automation
360 для извлечения определенного
значения из списка необходимо указать
соответствующий индекс.
Пример. Доступ к переменным Список
можно получить по индексу следующим
образом.
$listVariable[0]$

Здесь «0» представляет собой первое
значение в списке.

• Позиция индекса начинается с «1» в
Enterprise 10 или Enterprise 11, а в Automation
360 она начинается с «0».

• Поведение Enterprise 11.При
использовании списка с фиксированным
индексом в Enterprise 11 система возвращает
значение, доступное в первом индексе
списка.
Пример. For example, consider that you have
a list with values 1, 2, 3, and 4, and you use
$IntList(3)$ to retrieve the value in the third
index position of the list. Система возвращает
значение, доступное в первой позиции
индекса списка (1), вместо указанной позиции
индекса (3).
Поведение Automation 360.В Automation
360 система возвращает значение, доступное
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в указанной позиции индекса (в приведенном
выше примере возвращается значение «3»).
Behavior of migrated боты:боты Enterprise
11, которые используют такие выражения
с фиксированными индексами в списке и
переносятся в Automation 360, возвращают
значение, доступное в указанной позиции
индекса.

• Если список состоит из 10 элементов и цикл
выполняется более 10 раз, то Enterprise
10 или Enterprise 11 возвращает первое
значение списка после 10-й итерации.

Переменная списка Типы входных данных,
принимаемые функцией DLL

Когда система передает переменную списка
из бот Enterprise 11 в функцию DLL другого
типа, функция DLL принимает следующие типы
входных данных:
• UInt16[], Int16[], Int32[], Int64[], Int[], Char[],

Single[], Decimal[], Float[], Double[], Boolean[],
bool[], Byte[], String[] и Datetime[]

• UInt16, Int16, Int32, Int64, Int, Char, Single,
Decimal, Float, Double, Boolean, bool, Byte,
String и Datetime

• List<UInt16>, List<Int16>, List<Int32>,
List<Int64>, List<Int>, List<Char>,
List<Single>, List<Decimal>, List<Float>,
List<Double>List<Boolean>, List<bool>,
List<Byte>, List<String>, List<Date-Time>

• UInt16[,], Int16[,], Int32[,], Int64[,], Int[,],
Char[,], Single[,], Decimal[,], Float[,], Double[,],
Boolean[,], bool[,], Byte[,], String[,] и
Datetime[,]
См. также: Список пакет on page 1689.

Случайная
В этом разделе объясняется, как переменная Случайная переносится в Automation 360. В
некоторых случаях вам может потребоваться выполнить некоторые действия или обеспечить
определенные условия до или после миграции.

Подтип «Случайная строка» Для переменной «Случайная» подтипа
Строка в процессе миграции добавляется
действие Создать случайную строку пакета
Строка для генерации случайной строки над
условием Если и присваивается значение
соответствующей перенесенной переменной в
Automation 360.

Подтип «Случайное число» Для переменной «Случайная» подтипа Число
в процессе миграции добавляется действие
Присвоить случайное число пакета
Число для генерации случайной строки над
условием Если и присваивается значение
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соответствующей перенесенной переменной в
Automation 360.

Значение
В этом разделе объясняется, как Значение переносится в Automation 360. В некоторых случаях вам
может потребоваться выполнить некоторые действия или обеспечить определенные условия до или
после миграции.

Подтип «Значение» Эти переменные всегда переносятся в
Automation 360 в виде Строки, даже если они
содержат числовые, логические значения или
значения «Дата/время». При необходимости
для преобразования строки в другие типы в
Automation 360 используются выражения.

Подтип «Прочитать из текстового файла» To maintain the integrity of бот execution during
migration, where a variable that is declared by
reading a file is called, the Import string from
text file action of the String package is added just
above the action being migrated.
If Enterprise 11 боты contain variables that
read values from a text file, then these боты are
migrated using the Read variable action.
If a specific variable does not exist in the text file,
or if the specific variable is reading a value from
a file that does not exist, then Automation 360
generates an exception error.
After migration, when you run the бот that contains
the Read from file variable, the reading occurs
only once in the Read variables action at the
start of the бот running process. If the file that the
variable is trying to read gets updated while the
бот is running, then the Read file variable is not
refreshed.
.

Дополнительная информация Боты, которые используют переменные типа
«Значение» внутри переменной, можно
перенести в Automation 360. Для боты Enterprise
11, которые используют переменные внутри
переменной в команде Insert Keystrokes, action
Оценить значение пакет Строка добавляется в
перенесенный бот

См. также: Строка пакет on page 1895 | Число пакет on page 1710 | Boolean пакет on page 1434 |
Datetime пакет on page 1484

Системные переменные

В некоторых случаях системные переменные, такие как «Номер строки ошибки», «Описание
ошибки» и «Имя ОС», возвращают в Automation 360 другое значение. Если Боты используют эти
переменные в операциях принятия решений или строк, их требуется проверить после миграции.
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Некоторые системные переменные, используемые внутри цикла, после миграции становятся
переменными, определенными пользователем в цикле. В некоторых случаях может потребоваться
конфигурация переменной, определенной пользователем, в перенесенном бот.
Некоторые системные переменные переносятся в Automation 360 в виде действий. Эти действия
добавляются непосредственно над действием, которое использует эти переменные.
Если переменная определена в позиции индекса для следующих системных переменных, возможно,
вам потребуется разрешить перенесенные боты, поскольку в процессе миграции не удалось
определить, содержит ли переменная имя индекса или столбца. Если вы не решите эту проблему,
то бот может вернуть ошибку времени выполнения Ключ не найден в записи. В процессе
миграции значение переменной рассматривается как имя, но если это индекс, вы должны изменить
его соответствующим образом.
• $Filedata Column$
• $Dataset Column$
• $XML Data Node$
• $Excel Column$

В следующей таблице представлена информация о различных системных переменных и о том, как
они переносятся в Automation 360. Некоторые переменные входят в состав действий, некоторые
становятся действиями, а некоторые являются системными переменными, но имеют измененный
синтаксис.

Note:  Migrated боты do not preserve data outside of the loop for the following system variables:
• $FolderName$
• $FileName$
• $Extenstion$

Системная
переменная

Процесс миграции в Automation 360

$Day$ Becomes $System:Day.Number:toString$ in Automation 360

$FileName After migration, the system automatically creates this variable according
to the Automation 360 naming convention, to run the migrated боты
successfully.

$Error Description After migration, the system automatically creates this variable according
to the Automation 360 naming convention, to run the migrated боты
successfully.

$Error Line Number$ After migration, the system automatically creates this variable according
to the Automation 360 naming convention, to run the migrated боты
successfully.

$Extension$ After migration, the system automatically creates this variable according
to the Automation 360 naming convention, to run the migrated боты
successfully.

$Folder Name$ After migration, the system automatically creates this variable according
to the Automation 360 naming convention, to run the migrated боты
successfully.

$Month$ Becomes $System:Month.Number:toString$ in Automation 360

$Year$ Becomes $System:Year.Number:toString$ in Automation 360
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Системная
переменная

Процесс миграции в Automation 360

$Date$ Becomes $System:Date$ in Automation 360
Формат даты, установленный для переменной в бот Enterprise 11 или
Enterprise 10, хранится в глобальном значении AADefaultDateFormat.

$Hour$ Becomes $System:Hour.Number:toString$ in Automation 360

$Minute$ Becomes $System:Minute.Number:toString$ in Automation 360

$Clipboard$ Becomes $System:Clipboard$ in Automation 360

$Machine$ Becomes $System:Machine$ in Automation 360

$MiliSecond$ Becomes $System:MiliSecond.Number:toString$ in Automation 360

$ArrayColumns($arrayVariable
$)$

Becomes an expression in Automation 360:
$arrayVariable.DataTable:columnCount$

$ArrayRows($arrayVariable
$)$

Becomes an expression in Automation 360:
$arrayVariable.DataTable:rowCount$

$AAControlRoom$ Becomes $System:AAControlRoom$ in Automation 360

$RAMUsage$ Becomes $System:RAMUsage$ in Automation 360

$TotalRAM$ Becomes $System:TotalRAM$ in Automation 360

$OSName$ Enterprise 10 или Enterprise 11 возвращает значение Microsoft
Windows 10 Pro 64-разрядная. In Automation 360, this variable
becomes $System:OSName$ and returns the Windows 10 64-bit.

$CPUUsage$ Becomes $System:CPUUSage$ in Automation 360

$Counter$ Эта системная переменная устарела и не поддерживается в Automation
360. В процессе миграции создается определенная пользователем
переменная типа Число и изменяется бот, чтобы обеспечить те же
выходные данные, что и в бот версии 11.x.
Если вы использовали переменную $Counter$ в цикле, в процессе
миграции она будет заменена переменной $Condition-Counter$ в
перенесенном бот, а в качестве ее значения будет установлено «1».

$Dataset Column$ Эта системная переменная теперь входит в состав итератора Для
каждой строки в наборе данных SQL-запроса в Цикле. The system
creates a new variable in the loop and uses it inside the loop wherever
$Dataset Column$ is present.
Если переменная используется вне цикла, то она преобразуется
в определенную пользователем переменную типа «Запись» и
присваивается действию Запись, что позволяет присвоить значение
переменной исходной записи переменной целевой записи. Поэтому
при запуске перенесенных боты, которые содержат эту переменную,
отображаются данные из последней строки.
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Системная
переменная

Процесс миграции в Automation 360

$Excel Column$ Эта системная переменная теперь входит в состав итератора Для
каждой строки на листе в Цикле. The system creates a new variable in
the loop and uses it inside the loop wherever $Excel Column$ is present.
Если переменная используется вне цикла, то она преобразуется
в пользовательскую переменную типа «Запись» и присваивается
действию Запись, что позволяет присвоить значение переменной
исходной записи для переменной целевой записи. Поэтому при запуске
перенесенных боты, которые содержат эту переменную, отображаются
данные из последней строки.

$Extension$ и
$FileName$

Эти системные переменные использовались в итераторе Для каждого
файла в папке Цикла. Однако в Automation 360 используется
переменная типа «Словарь» для записи расширения и имени файла,
которые можно получить с помощью ключей «extension» и «name»
соответственно.

Цикл пакет on page 1695.

$Email$
$Email From$
$Email Message$
$Email Received
Date$
$Email Received
Time$
$Email Subject$
$Email To$
$Email Sent date$
$Email Sent time$

Эти системные переменные использовались внутри итератора Для
каждого сообщения в почтовом ящике Цикла. В Automation
360 переменная типа «Словарь» используется для записи всех
значений электронной почты, которые могут быть получены с помощью
соответствующих ключей.
См. раздел Using dictionary variable for email properties on page 1531.

$Filedata Column$ Эта системная переменная теперь входит в состав итератора Для
каждой строки в CSV/TXT в Цикле. The system creates a new variable
in the loop and uses it inside the loop wherever $Filedata Column$ is
present.
Если переменная используется вне цикла, то она преобразуется
в пользовательскую переменную типа «Запись» и присваивается
действию Запись, что позволяет присвоить значение переменной
исходной записи для переменной целевой записи. Поэтому при запуске
перенесенных боты, которые содержат эту переменную, отображаются
данные из последней строки.

$FolderName$ Эти системная переменная использовалась в итераторе Для каждой
папки в папке Цикла. В Automation 360 значение возвращается в
переменную строки, определенную в цикле.
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Процесс миграции в Automation 360

$Excel Cell Row$ Эта системная переменная переносится в действие Получить номер
строки пакета Excel в Automation 360 и добавляется непосредственно
над действием, в котором она используется.
In Enterprise 11, the last executed Excel session is used as a Session Name
value in the Excel Cell Row variable. However, in Automation 360, the
Excel Cell Row variable is not present. So, the last executed Excel session
used before Excel Cell Row is taken as a value for Get row number
during migration.
Обходное решение. Create a string variable, assign a name to it, and
add it after the Excel command in the migrated бот. Use the newly created
string variable in Get row number.

$Excel Cell Collumn$ Эта системная переменная переносится в действие Получить имя
столбца пакета Excel в Automation 360 и добавляется непосредственно
над действием, в котором она используется.
Enterprise 10/Enterprise 11 returns the first column (for example column A)
for the $Excel Cell Column$ even if the active cell is not column A (for
example column F10) inside a loop. В Automation 360 та же конфигурация
возвращает активную ячейку (например, столбец F10). Ниже приведены
примеры использования, которые приводят к вышеуказанному
изменению поведения.
• Открывается файл Excel, содержащий 10 строк, с установленным

флажком Содержит заголовок или без него.
• Установите F10 в виде активной ячейки
• Выполняется цикл для чтения строк
• Put a Message Box with $Excel Cell Column$ in it
• Запустите бот

Important:  Учитывая различия в поведении, вам, возможно,
потребуется изменить некоторые боты.

$Excel Cell$ Эта системная переменная переносится в действие Получить адрес
ячейки пакета Excel в Automation 360 и добавляется непосредственно
над действием, в котором она используется.
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$AATaskExecutor$ Эта системная переменная становится $AATaskExecutor$ и
$AATaskInvoker$ в Automation 360.
В Enterprise 11 эти переменные возвращают различные значения об
инициаторе и исполнителе задачи (например, имя, фамилию, адрес
электронной почты и имя пользователя-инициатора и исполнителя). В
Automation 360 переменная $AATaskInvoker$ возвращает следующие
значения.
• Invoker_Username
• Invoker_Firstname
• Invoker_Lastname
• Invoker_Email

Переменная $AATaskExecutor$ возвращает следующие значения.
• Executor_Username
• Executor_Firstname
• Executor_Lastname
• Executor_Email
• Executor_Type

$AATaskName$ Эта системная переменная становится $System.AATaskName$ в
Automation 360.
В Enterprise 10/Enterprise 11 эта переменная возвращает значение
в путь к каталогу на вашем компьютере (например, Automation
 Anywhere\My Tasks\My Folder\My Folder2\AATaskName.atmx).
В Automation 360 она возвращает значение в путь бот, относящийся к
Control Room (например Bots/AATaskName).

Action required:  Учитывая, что возвращаемые значения отличаются
между версиями, возможно, вам придется изменить некоторые боты.
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$AAApplicationPath$ Определено для Enterprise 11. Эта системная переменная Enterprise
11 возвращает путь, заданный пользователями с помощью настройки
Инструмент > Параметр так называемого “клиентского приложения”.
В Automation 360 переменная становится глобальным значением. В
процессе миграции это изменение отображается автоматически, и
набор значений каждого пользователя в Enterprise 11 копируется в
переменную глобального значения @AAApplicationPath.

Note:  Пользователю не требуется предпринимать никаких действий
для Enterprise 11, поскольку системная переменная автоматически
отображается в виде глобального значения во время миграции, если вы
использовали восстановленную базу данных Enterprise 11 при установке
Automation 360.

Определено для Enterprise 10. Эта системная переменная Enterprise
10 автоматически не переносится в Automation 360 в виде глобального
значения, поэтому после миграции необходимо предпринять
определенные действия.

Important:
• Пользователи Enterprise 10 должны создать глобальное значение

AAApplicationPath в Automation 360 и обновить его с помощью
пути Enterprise 10. Это обновление гарантирует, что при запуске
бот в Automation 360 значение папки AAApplicationPath будет
уникальным для каждого пользователя.
Пример. Если значение пути Enterprise 10 для AAApplicationPath —
D:\John.Doe\My Documents\Automation Anywhere Files,
необходимо создать глобальное значение AAApplicationPath в
Automation 360 и обновить с помощью этого пути.

• Убедитесь, что параметр МОЖЕТ быть изменено выбран при
создании глобального значения AAApplicationPath. Bot Creator и
Bot Runner должны установить значение для глобального значения
AAAplicationPath перед запуском перенесенных боты.

См. раздел Глобальные значения on page 2058.

$AAInstallationPath$ Эта системная переменная становится $System:AAInstallationPath$ в
Automation 360.
Enterprise 10/Enterprise 11 behavior: Returns the Enterprise Client
installation path (for example C:\Program Files (x86)\Automation
 Anywhere\Enterprise\Client).
Поведение Automation 360.Returns the Bot Agent installation path (for
example C:\Program Files\Automation Anywhere\Bot Agent).

Action required:  Учитывая, что возвращаемые значения отличаются
между версиями, возможно, вам придется изменить некоторые боты.
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$Current Directory$ Эта системная переменная устарела, поддерживается в Automation
360 и автоматически преобразуется в определенную пользователем
переменную во время миграции. The value of the variable is set per the
value defined in Loop > For each file in a folderr and For each folder in
a folder.

$Date$ Эта системная переменная становится $System:Date$ в Automation
360.
Enterprise 10 and Enterprise 11 behavior: Переменная $Date$
возвращает текущую дату и время в формате, указанном в файле
AA.Settings.XML.
Automation 360 behavior: Переменная $System:Date$ возвращает
значения типа Дата/время. Пользователи должны использовать
действие, чтобы изменить его на «Строка». Чтобы минимизировать
перебои в работе пользователей, в процессе миграции с каждым
экземпляром $Date$ выполняется следующее.
• Создается временная переменная $SystemDateInString$ типа

«Строка».
• Добавляется действие В строку пакета Дата/время для

преобразования $System:Date$ в строку с использованием
клиентского формата «MM/dd/yyy HH:mm:ss» и сохранения
результата в вышеуказанной переменной строки.

• Эта переменная строки используется везде, где используется $Date
$.

• Вышеописанные действия повторяются для каждого экземпляра
$Date$.

В зависимости от конфигурации вашего бот вам может потребоваться
обновить конфигурацию даты/времени.

Action required:  Измените бот, если формат даты отличается от MM/
dd/yyy HH:mm:ss.

$Error Line Number$
$Error Description$

В Enterprise 10 или Enterprise 11 эти системные переменные
используются после команды Обработка ошибок. В Automation 360
значение возвращается в определенные пользователем переменные,
указанные в цикле Выявить.

$PDFFileName$
$PDFTitle$
$PDFAuthor$
$PDFSubject$

В Enterprise 10 или Enterprise 11 эти системные переменные
использовались после любой команды PDF. В Automation 360
переменная типа «Словарь» используется для записи всех значений
PDF, которые могут быть получены с помощью соответствующих
ключей. Каждое действие PDF возвращает эту переменную словаря с
соответствующими значениями PDF.
См. раздел Using a dictionary variable for PDF properties on page 1755.

$System$ В Enterprise 11 или Enterprise 10 эта системная переменная
используется для получения информации о настройках устройства и его
производительности. В Automation 360 используется action Получить
переменную среды из пакет Система.
См. раздел Get environment variable action on page 1906.
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$WorkItem$ • $WorkItem$ — «Строка» Переносится в исходном виде.
• $WorkItem$ — «Число»

• Если отображается или регистрируется «Число», это число
изменяется на «Строку».

• Если тип отображается как «Число», перенесите его в виде
«Числа».

• $WorkItem$ — «Дата/время» Переносится в исходном виде,
но перенос пакета приводит к ошибке, поэтому перенос пакета
невозможен.

Note:  Для типа «Дата/время» пока нельзя перенести пакет, поэтому
связанный с ним бот нужно будет перенести в другой раз.

$Trigger Value$ В Automation 360 становится $TriggerValue$. Для боты Enterprise 11,
которые используют эту переменную, выполните следующие задачи,
чтобы успешно запустить перенесенный боты.
• Создайте эквивалентные триггеры в Automation 360 для всех

триггеров, использованных в боты Enterprise 11.
Выходные данные триггеров в Automation 360 хранятся в переменной
типа «Запись».

• Обновите перенесенный боты, чтобы использовать соответствующие
действия для присвоения значений из переменной записи,
содержащей выходные данные триггеров, переменной $TriggerValue$.
Например, если вы хотите присвоить ключ узла и порта из
переменной записи триггера электронной почты переменной
$TriggerValue$, используйте выражение $EmailTriggerData(host)$
$EmailTriggerData(port)$. Аналогичным образом, для получения
расположения файла используйте выражение $FileTriggerData(file)$,
а для получения расположения папки — выражение
$FolderTriggerData(fromFolder)$.

$Table Column$ Эта системная переменная теперь входит в состав итератора Для
каждой строки в таблице в Цикле. The system creates a new variable
in the loop and uses it inside the loop wherever $Table Column$ is
present.
Если переменная используется вне цикла, то она преобразуется
в пользовательскую переменную типа «Запись» и присваивается
действию Запись, что позволяет присвоить значение переменной
исходной записи для переменной целевой записи. Поэтому при запуске
перенесенных боты, которые содержат эту переменную, отображаются
данные из последней строки.
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$XML Data Node$ Эти системная переменная использовалась в итераторе Для каждого
узла в наборе данных XML Цикла. В Automation 360 значение
возвращается в переменную строки, определенную в цикле.
Если переменная используется вне цикла, то она преобразуется
в пользовательскую переменную типа «Строка» и присваивается
действию Запись, что позволяет присвоить значение переменной
исходной записи переменной целевой записи. Поэтому при запуске
перенесенных боты, которые содержат эту переменную, отображаются
данные из последней строки.

Переменные учетных данных

Переменные учетных данных, используемые для полей Имя пользователя и Пароль в Enterprise
10 и Enterprise 11, переносятся в Automation 360 как Переменные учетных данных.
Способ миграции различается для Enterprise 10 и Enterprise 11.
Чтобы узнать, как переносятся учетные данные Enterprise 10, см. раздел об учетных данных в
Процедура копирования данных Enterprise 10 в Automation 360 on page 1214.
Переменные учетных данных, используемые в полях, отличных от Имя пользователя и
Пароль, переносятся как Глобальные значения. К этим полям относится «Имя узла»,
«Номер порта» и т. д. Перенесенные глобальные значения имеют следующий синтаксис:
<credentialname>_<attributename>. For example in Enterprise 11, a credential FTPConnection
with an attribute hostname is migrated as FTPConnection_hostname.
В следующей таблице представлена информация о пакеты и actions, которые поддерживают перенос
переменных учетных данных из Enterprise 11 в Automation 360.

Пакет Действия

Active Directory • Создать и изменить пользователя
• Создать и изменить группу
• Создать и изменить объект
• Искать
• Получить свойство

База данных • Подключить с помощью строки подключения
• Имя пользователя
• Пароль

Email Automation • Имя узла
• Имя пользователя
• Пароль

Excel Открыть электронную таблицу

FTP / SFTP Подключить
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Пакет Действия

Insert Keystrokes Все нажатия клавиш, требующие использования
учетных данных

Legacy Automation Установить текст в действии «Управление
веб-элементами управления»

Manage Window Controls • Установить текст
• Добавить текст

PDF • PDF в изображение
• Извлечь поля формы
• Извлечь текст
• Разделить, зашифровать и расшифровать

документ

PGP • Зашифровать и расшифровать файлы
• Создать ключи

Средство записи • Установить текст
• Добавить текст

Note:  Перенесено из команды Object Cloning в
виде действия «Запись».

Веб-служба REST • URI
• Имя пользователя
• Пароль
• Заголовки
• Параметры операции

Note:  Доменное имя переносится в виде
глобального значения.

Веб-служба SOAP • Имя пользователя
• Пароль
• Заголовки
• Параметры операции
• Параметры с необработанными данными

Эмулятор терминала • Команда «Подключить» для SSH2 с
параметрами аутентификации пользователя
и файла ключа

• Отправить текст
• Установить поле
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Пакет Действия

Средство веб-записи Управлять веб-элементами управления с
помощью функций «Установить текст» и
«Добавить текст»

Глобальные значения в перенесенных боты
После миграции боты используют глобальные значения для поддержки различных возможностей,
предоставляемых в Enterprise 11 или Enterprise 10. Необходимо создать или обновить эти
глобальные значения в Automation 360 для запуска перенесенных боты.

Note:  Global values are created when you migrate боты for the first time using the Bot Migration Wizard
or migration APIs. If you are using the Migration package to migrate боты, you must create the global
values manually.

В следующей таблице перечислены различные глобальные значения, которые используются
перенесенными боты для успешной работы.

Глобальное значение Описание

AAApplicationPath Используйте это глобальное значение для
указания физического пути к бот или файлу,
который используется в текущем бот.
• Enterprise 11. Эта глобальная переменная

автоматически создается системой, если
при установке Automation 360 была
использована восстановленная базы
данных Enterprise 11.

• Enterprise 10. Необходимо создать
это глобальное значение в Automation
360 и добавить во все боты Enterprise
10, которые использовали системную
переменную AAApplicationPath для
глобального значения AAApplicationPath в
Automation 360, то же значение, что и в
Enterprise 10.

Процедура миграции переменной
AAApplicationPath on page 1246
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Глобальное значение Описание

AABasePath Это глобальное значение эквивалентно
параметру Начать пути задачи в Enterprise
11 или Enterprise 10.
В Enterprise 11 или Enterprise 10 этот
параметр используется для выбора
расположения новых файлов или папок, когда
в команде указан относительный путь к файлу
или папке. При миграции боты Enterprise
11 или Enterprise 10 следует учитывать
следующее.
• Если путь в бот Enterprise 11 или

Enterprise 10 является абсолютным, в
процессе миграции перенесенный бот не
изменяется.

• Если путь в бот Enterprise 11 или Enterprise
10 является относительным и не
содержит никакой переменной,
процесс миграции добавляет к пути
префикс глобального значения AABasePath.

• Если путь в бот Enterprise 11 или Enterprise
10 является относительным и содержит
переменные:
• если переменная содержит абсолютный

путь, в процессе выполнения
перенесенный бот не меняется;

• если переменная содержит
относительный путь, в процессе
выполнения к пути добавляется
префикс глобального значения
AABasePath.

AADefaultDateFormat Use this global value to change the default date
and time format for Date variables.

AAE_EmailSettings_auth Use this global value to enable or disable
authentication for the email server.

AAE_EmailSettings_clientId Use this global value to specify the client ID that
is generated when you registered the application
in the Microsoft Azure portal.

AAE_EmailSettings_domainName Use this global value to specify a domain name
for the email server.

AAE_EmailSettings_host Используйте это глобальное значение, чтобы
указать имя хоста сервера электронной
почты, который необходимо использовать для
отправки по электронной почте уведомлений
о статусе бот.
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Глобальное значение Описание

AAE_EmailSettings_port Используйте это глобальное значение,
чтобы указать порт, который необходимо
использовать для подключения к серверу
электронной почты.

AAE_EmailSettings_ssl Используйте это глобальное значение,
чтобы указать, использует ли учетная запись
электронной почты безопасное подключение.

AAE_EmailSettings_tenantId Используйте это глобальное значение, чтобы
указать идентификатор участника, который
генерируется при регистрации приложения на
портале Microsoft Azure.

AAProxyHost Use this global value to specify the proxy host
that will primarily be used by the Веб-служба
REST and Веб-служба SOAP actions.

AAProxyPort Use this global value to specify the proxy port
that will primarily be used by the Веб-служба
REST action.

AARestTimeOut Use this global value to specify the timeout
value, in milliseconds, for the Веб-служба REST
action. This value can be used when the REST
server takes a long time to respond.

AASoapTimeOut Use this global value to specify the timeout
value, in milliseconds, for the Веб-служба SOAP
action. This value can be used when the SOAP
server takes a long time to respond.

AAWaitForControl Use this global value to specify the maximum
wait time, in seconds, for the Control Room.

JcoDllPath Use this global value to specify the DLL path
for the Java connector used in SAP Business
Application Programming Interface (BAPI).

JcoJarPath Use this global value to specify the JAR path for
the Java connector used in SAP BAPI.

Проверка миграции бот
Важно убедиться, что миграция завершена и перенесенный бот функционирует в среде Automation
360. бот можно преобразовать, но он может содержать ошибки, которые препятствуют успешному
запуску.
1. Войдите в вашу среду Automation 360 на компьютере с установленным Bot Agent с помощью

учетной записи Bot Creator и разрешения «Просмотр миграции».
2. Убедитесь, что миграция выполнена, нажав Администрирование > Миграция.
3. Убедитесь, что ваш экземпляр миграции имеет статус Успешно (зеленая галочка), а в столбце

Перенесенный элемент указано значение 1 (т. е. перенесен 1 бот).
Если в столбце Перенесенный элемент отображается значение 0, то бот не перенесен и
будет недоступен на странице Автоматизация.
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4. Убедитесь, что бот работает, нажав Действия > В процессе выполнения.
5. Перейдите к перенесенному бот.

Например, если вы перенесли бот из папки My Tasks, перейдите в ту же папку, чтобы найти
перенесенный бот.

6. Щелкните бот и исправьте все ошибки.
7. Запустите бот, чтобы убедиться, что все ошибки исправлены.

Related concepts
Миграция в Automation 360 on page 1133
Related tasks
Просмотр изменений в перенесенных боты с помощью Бот Assistant on page 1317
Бот Assistant обеспечивает полный обзор всех строк в бот, которые требуют внимания или действия,
или в которых есть ошибки для устранения. Вы можете быстро определить области боты, которые
требуют внимания, и просмотреть изменения в бот Enterprise 11 или Enterprise 10 после миграции в
Automation 360.

Просмотр отчетов о переносе данных
Используйте отчеты для анализа состояния миграции отдельных бот, миграции данных и миграции
журнала аудита, а также для определения состояния отдельной миграции и сводки по ней.
У вас должно быть разрешение Просмотр миграции для доступа к этим отчетам.
Отчеты о миграции содержат сводку и состояние, которые зависят от типа миграции:
• Миграция бот, которая включает в себя подробную информацию о преобразовании ботов

Enterprise 10 или Enterprise 11 в Automation 360.
• Миграция данных, которая включает в себя подробную информацию о копировании данных

Enterprise 10 в Automation 360.
• Миграция аудита, которая включает в себя подробную информацию о перенесенных данных

журнала аудита Enterprise 11 в Automation 360.

Access the reports from the Administration > Migrations > View migration icon associated with the
migration instance for which you want to view the report.
• Отчеты о миграции Бот. Применимо как к Enterprise 10, так и к Enterprise 11.

Просмотрите следующую информацию:
• Сведения о миграции, такие как имя экземпляра миграции, его описание и состояние.
• Результаты миграции: время начала и окончания миграции, состояние миграции и количество

перенесенных элементов.
• Настройки: Была ли выбрана опция перезаписи файлов.
• Bot Runner: Информация о пользователе run-as, выбранном для экземпляра миграции.
• Результаты миграции Бот: все боты (родительские боты и их дочерние боты), которые

перенесены, и их состояние.
В результатах миграции бот отдельно перечисляются боты, для которых после миграции могут
потребоваться действия или проверки. Переходите по вкладкам для просмотра списков боты,
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для которых требуются действия или проверки, и соответствующим образом планируйте шаги
после миграции.
Щелкните значок «Просмотр проблем при миграции», связанный с неудачной миграцией бот,
чтобы увидеть неподдерживаемые команды и атрибуты.

• Общие сведения о пользователе, создавшем экземпляр миграции, дата последнего изменения
и тип объекта.

• Результаты переноса Bot Insight: Применимо только к Enterprise 11.
Посмотрите результаты Bot Insight, если вы выполнили миграцию боты аналитики Enterprise
11. На этой вкладке отображается следующая информация: статус миграции Bot Insight,
количество информационных панелей Bot Insight, а также строки данных, которые
перенесены, не перенесены или пропущены.

• Отчеты о миграции данных: Применимо только к Enterprise 10.
Просмотрите следующую информацию:
• Сведения о миграции, такие как имя экземпляра миграции, его описание и состояние.
• Результаты миграции данных: время начала и окончания миграции, состояние миграции и

количество перенесенных элементов.
• Функции, которые скопированы, и их состояние.
• Пользователи, которые скопированы, и их состояние.
• Учетные данные для автоматического входа в систему, которые скопированы, и их состояние.
• Боты, которые скопированы, и их состояние.
• Расписания, которые скопированы, и их состояние. Скопированные расписания отключены

в Automation 360, так как миграция связанных устройств не поддерживается, и поэтому они
недоступны.

• Общие сведения о пользователе, создавшем экземпляр миграции, дата последнего изменения
и тип объекта.

• Отчеты о миграции журнала аудита: Применимо только к Enterprise 11.
Просмотрите следующую информацию:
• Сведения о миграции: имя экземпляра миграции, его описание и общее состояние миграции,

например «В процессе выполнения», «Успешно» или «Неуспешно».
• Результаты миграции: время начала и окончания процесса миграции, продолжительность,

количество элементов, которые перенесены, не перенесены или пропущены.
• Результаты миграции журнала аудита: путь к файлам JSON журнала аудита, состояние

каждого файла es_export.json, если файл пропущен, перенесен, не перенесен или
ожидает миграции. В результатах также отображаются причины, по которым определенный
файл es_export.json пропущен или получил состояние «Неуспешно» при миграции
журналов аудита.

• Общие сведения о пользователе, создавшем экземпляр миграции, дата последнего изменения
и тип объекта.

View the following video on how to review the bot migration report:

Экспортировать в CSV
В файл CSV можно экспортировать два набора данных: экземпляры миграций со страницы Все
миграции и данные о результатах миграции бот, включая любые сопоставления действий
для каждого бота. Экспортированные данные можно использовать для автономного анализа и
определения боты, миграция которых завершилась сбоем, и связанных с ними неудачных действий.
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В процессе миграции экспортируются все данные экземпляров миграции (включая скрытые столбцы
данных), но только для текущей страницы. Если экземпляры миграции есть на дополнительных
страницах, необходимо перейти на эти страницы, чтобы экспортировать данные. Для данных
результатов миграции экспортируются все страницы, даже если данные находятся на разных
страницах.
Выполнять экспорт могут пользователи с разрешением «Просмотр миграции».
1. Click Administration > Migrations.
2. Экспортируйте экземпляры миграции.

a) Установите флажки для экземпляров миграции, которые вы хотите экспортировать.
b) Щелкните по значку Экспорт отмеченных элементов в CSV.

3. Экспортируйте данные результатов миграции.
a) Выберите экземпляр миграции, в котором Тип — «Миграция Бот», который вы хотите

экспортировать.
Экспортировать можно только результаты миграции бот.

b) Выберите параметр Экспортировать результаты миграции ботов, чтобы
экспортировать данные.
Кроме того, можно экспортировать данные из отчета «Миграция».

4. Откройте файл CSV, чтобы просмотреть экспортированные данные.

Просмотр изменений в перенесенных боты с помощью Бот
Assistant
Бот Assistant обеспечивает полный обзор всех строк в бот, которые требуют внимания или действия,
или в которых есть ошибки для устранения. Вы можете быстро определить области боты, которые
требуют внимания, и просмотреть изменения в бот Enterprise 11 или Enterprise 10 после миграции в
Automation 360.
• боты Enterprise 11 или Enterprise 10 должны быть перенесены в Automation 360.
• У пользователя, просматривающего сообщения об обзоре миграции и действиях, должна быть

лицензия Bot Creator или Bot Runner.
• У Bot Creator должно быть разрешение Просмотр миграции для просмотра сообщений об

обзоре миграции и действиях в Бот Assistant.

Сообщения доступны для боты, которые успешно перенесены в Automation 360 (но с некоторыми
изменениями в перенесенных боты). Эти сообщения указывают на изменения в поведении команд
Enterprise 11 или Enterprise 10 после того, как они перенесены в Automation 360.
Вы можете открыть Бот Assistant для перенесенного бот, который указан на вкладке Сообщения в
отчете Bot Scanner. Просмотрите сообщения об изменениях в командах после миграции и отметьте
эти сообщения как просмотренные после анализа изменений. Бот Assistant также позволяет
просматривать все изменения, внесенные в бот из Bot editor.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Откройте перенесенный бот, для которого вы хотите просмотреть сообщения.
3. Щелкните по значку Бот Assistant на панели инструментов, чтобы открыть Бот Assistant.
4. Щелкните Начать.
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5. На экране Бот Assistant щелкните вкладку Требуется проверка, чтобы отобразить сообщения,
требующие просмотра.

6. Щелкните сообщение на вкладке Требуется проверка, чтобы просмотреть подробную
информацию об изменении.

7. Щелкните параметр Отметить как проверенный, чтобы отметить сообщение как
просмотренное.
Сообщения, отмеченные как проверенные, доступны на вкладке Проверенные.

Note:  Вы можете отметить сообщение как проверенное только для перенесенных боты,
которые доступны в вашем личном репозитории.

See the following video on how to use the Bot Assistant to review changes to migrated боты

Сообщения при выполнении миграции
Migration messages might display at any stage of the migration or Internet Explorer бот conversion. You
can review or act on migration messages from these possible sources: Bot Scanner report, Бот Assistant or
Бот migration report.

Note:
• Some messages described on this page do not include a cause or action when the cause is provided as

part of the message and do not require any further action.
• This page also includes Internet Explorer conversion messages that are applicable only for customers

impacted by the Internet Explorer end-of-life (EOL) and have chosen to convert IE боты.

Сообщения о необходимости выполнить действия

These messages in the Bot Scanner report, Bot Migration Wizard, and Migration Assistant after you migrate
the боты. You must perform certain actions to successfully run the боты. We recommend that you review
the cause and action required to update and run these боты.

Код: A101

Сообщение Для запуска перенесенного бота обновите переменную <имя>,
если переменная используется в качестве позиции индекса, а
не имени столбца.

Если переменная используется в качестве имени столбца, то
дальнейшие действия не требуются. Если она используется
в качестве позиции индекса, создайте новую переменную
числового типа. Также обратите внимание, что Automation 360
начинает позицию индекса с 0, а не с 1.

Причина If you used the FileData Column[$variable$] or Excel
 Column[$variable$] system variables in the Enterprise 11 or Enterprise
10 бот, it is assumed that you have used the column name in the $variable$. In
such cases, the migrated бот contains the FileData Column{$variable$}
expression.
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Действие If the $variable$ in the Enterprise 11 or Enterprise 10 бот contains
the column number, update the expression in the migrated бот to
FileDataColumn[$var.String:toNumber()$].

Код: A103

Сообщение Для запуска перенесенного бота обновите действие Task
bot:Действие Запустить в перенесенном боте, указав
переменную учетных данных для входного параметра.Переменная
«Хранилище учетных данных» не должна быть передана
небезопасным способом.

Причина В полях в перенесенном бот Enterprise 11 или Enterprise 10 значения
отображаются в виде обычного текста. Чтобы предотвратить нарушение
безопасности в Automation 360, запрещается передавать переменную
Credential Vault небезопасным способом.

Неподдерживаемые функции с обходным решением

Код: A108

Сообщение Для запуска перенесенного бота обновите действие в
перенесенном боте, указав соответствующее значение Хранилище
учетных данных.

Значение Хранилище учетных данных Automation 360 должно
совпадать со значением Хранилище учетных данных версии
10.x / 11.x.

Причина The migrated бот does not have the Credential Vault value assigned to the
corresponding action.

Действие Для запуска перемещенного бот создайте или обновите значение
Хранилище учетных данных и назначьте его соответствующему
действию. Проверьте, что значение Хранилище учетных данных в
Automation 360 совпадает со значением Хранилище учетных данных
Enterprise 10 или Enterprise 11.

Код: A109

Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите в нем
соответствующие действия, указав отсутствующие требуемые
переменные.

Причина бот Enterprise 11 или Enterprise 10 связан с несуществующей переменной в
команде Операция переменной.
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Действие Создайте переменную с таким же именем и типом или удалите команду,
которая связана с несуществующей переменной.

Код: A110

Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите действие IF
в перенесенном боте, указав отсутствующие требуемые
переменные.

Причина бот Enterprise 11 или Enterprise 10 связан с несуществующей переменной в
команде If.

Действие Создайте переменную с таким же именем и типом или удалите команду,
которая связана с несуществующей переменной.

Код: A111

Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите действие Назначить
буферу обмена в перенесенном боте, указав отсутствующие
требуемые переменные.

Причина бот Enterprise 11 или Enterprise 10 связан с несуществующей переменной в
команде Назначить буферу обмена.

Действие Обновите действие Назначить буферу обмена, указав отсутствующую
требуемую переменную в перенесенном бот, чтобы связанные переменные
были одинакового типа.

Код: A112

Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите действие ElseIF
в перенесенном боте, указав отсутствующие требуемые
переменные.

Причина бот Enterprise 11 или Enterprise 10 связан с несуществующей переменной в
команде ElseIF.

Действие Создайте переменную с таким же именем и типом или удалите команду,
которая связана с несуществующей переменной.

Код: A113
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Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите действие Цикл
в перенесенном боте, указав отсутствующие требуемые
переменные.

Причина бот Enterprise 11 или Enterprise 10 связан с несуществующей переменной в
команде Цикл.

Действие Создайте переменную с таким же именем и типом или удалите команду,
которая связана с несуществующей переменной.

Код: A116

Сообщение The MetaBot Logic referenced in the TaskBot is missing. For
the migrated bot to run, ensure the referenced MetaBot logic
bot is available at the required path in A360. Message code:
A116

Причина The Enterprise 11 or Enterprise 10 бот references a non-existent Taskbot.

Действие Ensure that the MetaBot Логика бот exists in Automation 360.

Код: A117

Сообщение The MetaBot Logic referenced in the parent MetaBot Logic is
missing. For the migrated bot to run, ensure the referenced
MetaBot Logic bot is available at the required path in A360.
Message code: A117

Причина The Enterprise 11 or Enterprise 10 parent MetaBot Логика references are
missing.

Действие Ensure that the MetaBot Логика бот exists in Automation 360.

Код: A118

Сообщение Для запуска перенесенного бота убедитесь, что дочерний бот
доступен по указанному пути.

Для запуска родительского бота требуется дочерний MetaBot.

Причина When migrating a parent бот, if you have not migrated the child бот or you
migrated the child бот at a different location.
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Действие Проверьте, что вы перенесли дочерний бот. Затем выполните одно из
следующих действий.
• Update the link within the parent бот so that it points to the correct location of

the migrated child бот.
• Переместите дочерний бот в то же расположение, что и родительский

бот.

Код: A119

Сообщение В боте V10/11 отсутствует связанный DLL-файл.

For the migrated bot to run, ensure the referenced DLL file
is available at the required path.

Причина Эта проблема возникает при миграции родительского бот, если не перенесен
DLL-файл или если DLL-файл перенесен в другое расположение.

Действие Проверьте, что вы перенесли указанный DLL-файл. Затем выполните одно из
следующих действий.
• Обновите ссылку внутри перенесенного бот, чтобы ссылка указывала на

правильное расположение перенесенного DLL-файла.
• Переместите DLL-файл в то же расположение, что и перенесенный бот.

Код: A124

Сообщение Действие «Воспроизвести звук» было перенесено. Форматы
файлов .mid, .wma и .avi не поддерживаются.

Чтобы запустить перенесенного бота, преобразуйте файлы в
формат .mp3 или .wav.

Код: A125

Сообщение Значение учетных данных нестрокового типа не поддерживается
для функции «DLL — запустить» в перенесенном боте.

Для запуска перенесенного бота обновите функцию «DLL —
запустить» с помощью переменной учетных данных строкового
типа или глобального значения соответствующего типа
переменной и соответствующего сопоставления.

Более подробную информацию см. в документации.

Причина Для действия DLL — запустить поддерживается значение учетных данных
только строкового типа. If the credential value is deleted from the DLL Run
command in the Enterprise 10 or Enterprise 11 бот, then this issue occurs.
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Действие Обновите действие DLL — запустить в перенесенном бот, указав значение
учетных данных строкового типа и сопоставьте его с соответствующими
параметрами в перенесенном бот для запуска. Если вы хотите передать
переменную не строкового типа, создайте глобальное значение нужной
переменной и сопоставьте его с действием DLL — запустить.

Код: A126

Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите действие «Строка —
до/после» в перенесенном боте, указав отсутствующие
требуемые переменные.

Причина In the Enterprise 10 or Enterprise 11 бот, if the referenced variable is deleted
from the String-BeforeAfter command, there are no issues. Однако после
миграции отсутствующая переменная вызывает проблему, так как связанная
переменная необходима для запуска бот в Automation 360.

Действие Поскольку связанная переменная необходима для запуска бот, создайте
недостающую переменную и присвойте ее действию Строка — до/после.

Код: A127

Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите действие «Строка —
сравнить» в перенесенном боте, указав отсутствующие
требуемые переменные.

Причина In the Enterprise 10 or Enterprise 11 бот, if the referenced variable is deleted
from the String-Compare command, there are no issues. Однако после
миграции отсутствующая переменная вызывает проблему, так как связанная
переменная необходима для запуска бот в Automation 360.

Действие Поскольку связанная переменная необходима для запуска бот, создайте
недостающую переменную и присвойте ее действию Строка — сравнить.

Код: A128

Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите действие «Строка —
найти» в перенесенном боте, указав отсутствующие требуемые
переменные.

Причина In the Enterprise 10 or Enterprise 11 бот, if the referenced variable is deleted
from the String-Find command, there are no issues. Однако после миграции
отсутствующая переменная вызывает проблему, так как связанная
переменная необходима для запуска бот в Automation 360.
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Действие Поскольку связанная переменная необходима для запуска бот, создайте
недостающую переменную и присвойте ее действию Строка — найти.

Код: A129

Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите действие «Строка —
соединить» в перенесенном боте, указав отсутствующие
требуемые переменные.

Причина In the Enterprise 10 or Enterprise 11 бот, if the referenced variable is deleted
from the String-Join command, there are no issues. Однако после миграции
отсутствующая переменная вызывает проблему, так как связанная
переменная необходима для запуска бот в Automation 360.

Действие Поскольку связанная переменная необходима для запуска бот, создайте
недостающую переменную и присвойте ее действию Строка — соединить.

Код: A130

Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите действие «Строка —
длина» в перенесенном боте, указав отсутствующие требуемые
переменные.

Причина In the Enterprise 10 or Enterprise 11 бот, if the referenced variable is deleted
from the String-Length command, there are no issues. Однако после
миграции отсутствующая переменная вызывает проблему, так как связанная
переменная необходима для запуска бот в Automation 360.

Действие Поскольку связанная переменная необходима для запуска бот, создайте
недостающую переменную и присвойте ее действию Строка — длина.

Код: A131

Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите действие «Строка —
нижний регистр» в перенесенном боте, указав отсутствующие
требуемые переменные.

Причина In the Enterprise 10 or Enterprise 11 бот, if the referenced variable is deleted
from the String-Lowercase command, there are no issues. Однако после
миграции отсутствующая переменная вызывает проблему, так как связанная
переменная необходима для запуска бот в Automation 360.
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Действие Поскольку связанная переменная необходима для запуска бот, создайте
недостающую переменную и присвойте ее действию Строка — нижний
регистр.

Код: A132

Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите действие «Строка —
заменить» в перенесенном боте, указав отсутствующие
требуемые переменные.

Причина In the Enterprise 10 or Enterprise 11 бот, if the referenced variable is deleted
from the String-Replace command, there are no issues. Однако после
миграции отсутствующая переменная вызывает проблему, так как связанная
переменная необходима для запуска бот в Automation 360.

Действие Поскольку связанная переменная необходима для запуска бот, создайте
недостающую переменную и присвойте ее действию Строка — заменить.

Код: A133

Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите действие «Строка —
обратный порядок» в перенесенном боте, указав отсутствующие
требуемые переменные.

Причина In the Enterprise 10 or Enterprise 11 бот, if the referenced variable is deleted
from the String-Reverse command,, there are no issues. Однако после
миграции отсутствующая переменная вызывает проблему, так как связанная
переменная необходима для запуска бот в Automation 360.

Действие Поскольку связанная переменная необходима для запуска бот, создайте
недостающую переменную и присвойте ее действию Строка — обратный
порядок.

Код: A134

Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите действие «Строка —
подстрока» в перенесенном боте, указав отсутствующие
требуемые переменные.

Причина In the Enterprise 10 or Enterprise 11 бот, if the referenced variable is deleted
from the String-Substring command, there are no issues. Однако после
миграции отсутствующая переменная вызывает проблему, так как связанная
переменная необходима для запуска бот в Automation 360.
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Действие Поскольку связанная переменная необходима для запуска бот, создайте
недостающую переменную и присвойте ее действию Строка — подстрока.

Код: A135

Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите действие «Строка —
обрезать» в перенесенном боте, указав отсутствующие
требуемые переменные.

Причина In the Enterprise 10 or Enterprise 11 бот, if the referenced variable is deleted
from the String-Trim command, there are no issues. Однако после миграции
отсутствующая переменная вызывает проблему, так как связанная
переменная необходима для запуска бот в Automation 360.

Действие Поскольку связанная переменная необходима для запуска бот, создайте
недостающую переменную и присвойте ее действию Строка — обрезать.

Код: A136

Сообщение В боте V10/11 отсутствуют связанные переменные.

Для запуска перенесенного бота обновите действие «Строка —
верхний регистр» в перенесенном боте, указав отсутствующие
требуемые переменные.

Причина In the Enterprise 10 or Enterprise 11 бот, if the referenced variable is deleted
from the String-Uppercase command, there are no issues. Однако после
миграции отсутствующая переменная вызывает проблему, так как связанная
переменная необходима для запуска бот в Automation 360.

Действие Поскольку связанная переменная необходима для запуска бот, создайте
недостающую переменную и присвойте ее действию Строка — верхний
регистр.

Код: A137

Сообщение В боте V10/11 отсутствует переменная.

Для запуска перенесенного бота обновите действие «Строка —
до/после» в перенесенном боте, указав допустимую переменную.

Причина The unsupported variable type is assigned to the String-BeforeAfter action in
the migrated Enterprise 10 or Enterprise 11 бот.

Действие Чтобы запустить перенесенный бот, создайте действительную переменную
строкового типа и присвойте ее действию Строка — до/после.
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Код: A138

Сообщение В боте V10/11 отсутствует переменная.

Для запуска перенесенного бота обновите действие «Строка —
сравнить» в перенесенном боте, указав допустимую переменную.

Причина The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 бот.

Действие Чтобы запустить перенесенный бот, создайте переменную строкового типа и
присвойте ее действию.

Код: A139

Сообщение В боте V10/11 отсутствует переменная.

Для запуска перенесенного бота обновите действие «Строка —
найти» в перенесенном боте, указав допустимую переменную.

Причина The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 бот.

Действие Чтобы запустить перенесенный бот, создайте переменную строкового типа и
присвойте ее действию.

Код: A140

Сообщение В боте V10/11 отсутствует переменная.

Для запуска перенесенного бота обновите действие «Строка —
соединить» в перенесенном боте, указав допустимую
переменную.

Причина The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 бот.

Действие Чтобы запустить перенесенный бот, создайте переменную строкового типа и
присвойте ее действию.

Код: A141

Сообщение В боте V10/11 отсутствует переменная.

Для запуска перенесенного бота обновите действие «Строка —
длина» в перенесенном боте, указав допустимую переменную.

Причина The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 бот.
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Действие Чтобы запустить перенесенный бот, создайте переменную строкового типа и
присвойте ее действию.

Код: A142

Сообщение В боте V10/11 отсутствует переменная.

Для запуска перенесенного бота обновите действие «Строка —
нижний регистр» в перенесенном боте, указав допустимую
переменную.

Причина The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 бот.

Действие Чтобы запустить перенесенный бот, создайте переменную строкового типа и
присвойте ее действию.

Код: A143

Сообщение В боте V10/11 отсутствует переменная.

Для запуска перенесенного бота обновите действие «Строка —
заменить» в перенесенном боте, указав допустимую переменную.

Причина The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 бот.

Действие Чтобы запустить перенесенный бот, создайте переменную строкового типа и
присвойте ее действию.

Код: A144

Сообщение В боте V10/11 отсутствует переменная.

Для запуска перенесенного бота обновите действие «Строка —
обратный порядок» в перенесенном боте, указав допустимую
переменную.

Причина The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 бот.

Действие Чтобы запустить перенесенный бот, создайте переменную строкового типа и
присвойте ее действию.

Код: A145
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Сообщение В боте V10/11 отсутствует переменная.

Для запуска перенесенного бота обновите действие «Строка —
подстрока» в перенесенном боте, указав допустимую
переменную.

Причина The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 бот.

Действие Чтобы запустить перенесенный бот, создайте переменную строкового типа и
присвойте ее действию.

Код: A146

Сообщение В боте V10/11 отсутствует переменная.

Для запуска перенесенного бота обновите действие «Строка —
обрезать» в перенесенном боте, указав допустимую переменную.

Причина The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 бот.

Действие Чтобы запустить перенесенный бот, создайте действительную переменную
строкового типа и назначьте ее действию.

Код: A147

Сообщение В боте V10/11 отсутствует переменная.

Для запуска перенесенного бота обновите действие «Строка —
верхний регистр» в перенесенном боте, указав допустимую
переменную.

Причина The unsupported variable type is assigned to the action in the migrated
Enterprise 10 or Enterprise 11 бот.

Действие Чтобы запустить перенесенный бот, создайте действительную переменную
строкового типа и назначьте ее действию.

Код: A149

Сообщение MetaBot screen that is referenced in the Logic is not
present in the MetaBot. For the migrated bot to run, update
the object details in the Recorder action. Message code:
A149

Причина Screen details are missing in the Средство записи package of the migrated бот.
Сведения об экране требуются в Automation 360.
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Действие Необходимо вручную записать сведения об экране в перенесенном бот для
его успешного запуска.

Код: A151

Note:  As of v.27, боты that contain non-referenced variables are not flagged
as Action Required or Review Required in the Bot Scanner utility for the
following variables:
• $Excel Column$
• $Filedata Column$
• $Dataset Column$
• $Table Column$
• $XML Data Node$
• $PDFTitle$
• $PDFSubject$
• $PDFFileName$
• $PDFAuthor$

Note:  As of v.25, боты that contain non-referenced variables are not flagged as
Action Required in the Bot Scanner utility for the following variables:
• '$Error Description$'
• '$Error Line Number$'
• '$FileName$'
• '$Extension$'
• $FolderName$'
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Сообщения 1. Имя переменной «$Error Description$» перенесено как
«$Error-Description$».

Переменная «$Error Description$», используемая в версии
10.x/ 11.x, не создана в A360, так как отсутствуют
действия от соответствующих пакетов.

Для запуска перенесенного бота создайте переменную с тем
же именем «$Error-Description$» или удалите переменную из
соответствующего действия.

2. Имя переменной «$Error Line Number$» перенесено как
«$Error-LineNumber$».

Переменная «$Error Line Number$», используемая в версии
10.x/ 11.x, не создана в A360, так как отсутствуют
действия от соответствующих пакетов.

Для запуска перенесенного бота создайте переменную с тем
же именем «$Error-LineNumber$» или удалите переменную из
соответствующего действия.

3. Имя переменной «$FileName$» перенесено как «$Loop-Files
$».
Переменная «$FileName$», используемая в версии 10.x/
11.x, не создана в A360, так как отсутствуют действия от
соответствующих пакетов.

Для запуска перенесенного бота создайте переменную с
тем же именем «$Loop-Files$» или удалите переменную из
соответствующего действия.

4. Имя переменной «$Extension$» перенесено как «$Loop-Files
$».
Переменная «$Extension$», используемая в версии 10.x/
11.x, не создана в A360, так как отсутствуют действия от
соответствующих пакетов.

Для запуска перенесенного бота создайте переменную с
тем же именем «$Loop-Files$» или удалите переменную из
соответствующего действия.

5. Имя переменной «$FolderName$» перенесено как «$Loop-
FolderName$».
Переменная «$FolderName$», используемая в версии 10.x/
11.x, не создана в A360, так как отсутствуют действия от
соответствующих пакетов.

For the migrated bot to run, create a variable with the
same name '$Loop-FolderName$' or remove the variable from
the respective action.

6. Имя переменной «$PDFAuthor$» перенесено как «$PDF-
Metadata-Dictionary$».

Переменная «$PDFAuthor$», используемая в версии 10.x/
11.x, не создана в A360, так как отсутствуют действия от
соответствующих пакетов.

Для запуска перенесенного бота создайте переменную с
тем же именем «$PDF-Metadata-Dictionary$» или удалите
переменную из соответствующего действия.

7. Имя переменной «$PDFFileName$» перенесено как «$PDF-
Metadata-Dictionary$».
The '$PDFFileName$' variable used in version 10.x/ 11.x
is not created in the A360 due to the absence of actions
from corresponding packages.

Для запуска перенесенного бота создайте переменную с
тем же именем «$PDF-Metadata-Dictionary$» или удалите
переменную из соответствующего действия.

8. Имя переменной «$PDFSubject$» перенесено как «$PDF-Metadata-
Dictionary$».
Переменная «$PDFSubject$», используемая в версии 10.x/
11.x, не создана в A360, так как отсутствуют действия от
соответствующих пакетов.

Для запуска перенесенного бота создайте переменную с
тем же именем «$PDF-Metadata-Dictionary$» или удалите
переменную из соответствующего действия.

9. Имя переменной «$PDFTitle$» перенесено как «$PDF-
Metadata-Dictionary$».

Переменная «$PDFTitle$», используемая в версии 10.x/
11.x, не создана в A360, так как отсутствуют действия от
соответствующих пакетов.

Для запуска перенесенного бота создайте переменную с
тем же именем «$PDF-Metadata-Dictionary$» или удалите
переменную из соответствующего действия.

10. Имя переменной «$XML Data Node$» перенесено как «$Loop-
XML-Data-Node$».

Переменная «$XML Data Node$», используемая в версии 10.x/
11.x, не создана в A360, так как отсутствуют действия от
соответствующих пакетов.

Для запуска перенесенного бота создайте переменную с тем
же именем «$Loop-XML-Data-Node$» или удалите переменную
из соответствующего действия.

11. Имя переменной «$Excel Column$» перенесено как «$Loop-
Excel-Column$».

Переменная «$Excel Column$», используемая в версии 10.x/
11.x, не создана в A360, так как отсутствуют действия от
соответствующих пакетов.

Для запуска перенесенного бота создайте переменную с тем
же именем «$Loop-Excel-Column$» или удалите переменную из
соответствующего действия.

12. Имя переменной «$Table Column$» перенесено как «$Loop-
Table-Column$».

Переменная «$Table Column$», используемая в версии 10.x/
11.x, не создана в A360, так как отсутствуют действия от
соответствующих пакетов.

Для запуска перенесенного бота создайте переменную с тем
же именем «$Loop-Table-Column$» или удалите переменную из
соответствующего действия.

13. Имя переменной «$WorkItemResult$» перенесено как
«$workItemResult$».

Переменная «$WorkItemResult$», используемая в версии
10.x/ 11.x, не создана в A360, так как отсутствуют
действия от соответствующих пакетов.

Для запуска перенесенного бота создайте переменную с тем
же именем «$workItemResult$» или удалите переменную из
соответствующего действия.

14. Имя переменной «$Dataset Column$» перенесено как «$Loop-
Dataset-Column$».

Переменная «$Dataset Column$», используемая в версии
10.x/ 11.x, не создана в A360, так как отсутствуют
действия от соответствующих пакетов.

Для запуска перенесенного бота создайте переменную с тем
же именем «$Loop-Dataset-Column$» или удалите переменную
из соответствующего действия.

15. Имя переменной «$Filedata Column$» перенесено как «$Loop-
Filedata-Column$».

Переменная «$Filedata Column$», используемая в версии
10.x/ 11.x, не создана в A360, так как отсутствуют
действия от соответствующих пакетов.

Для запуска перенесенного бота создайте переменную с тем
же именем «$Loop-Filedata-Column$» или удалите переменную
из соответствующего действия.
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Причина (Applies to all A151 messages): Эта проблема возникает, если определенная
переменная не создана в Automation 360, так как в соответствующем пакете
отсутствуют действия.

Действие (Applies to all A151 messages): Вы должны создать переменную
соответствующего типа (строка, число, словарь и так далее) с тем же
именем в Automation 360 или удалить переменную из соответствующего
действия, чтобы запустить перенесенный бот.

Код: A152

Сообщение Бот был перенесен.

Размер переменных типа «Массив» превышает 160 000. Некоторые
переменные типа «Массив» переносятся как переменные типа
«Таблица» в A360 без значений по умолчанию.

Чтобы бот предоставил одинаковые результаты, может
потребоваться значение по умолчанию для переменной типа
«Таблица».

Код: A154

Сообщение For the migrated бот to run, update the 'Simulate
keystrokes' action. The excel paste special behavior in A360
is different from the version 10.x/11.x. Message Code: A154

Причина The Paste Special dialog box varies between Automation 360, Enterprise
11, and Enterprise 10. As a result, the Имитация нажатия клавиш command
functions differently.

Действие Update the Имитация нажатия клавиш command in the migrated бот.

Код: A155

Сообщение Для запуска перенесенного бота обновите имя бота в команде
«Выполнить задачу». Логика MetaBot перенесена путем
добавления суффикса «-bot» к имени файла.

Причина Когда у Логика и папки в MetaBot одинаковые имена в Enterprise 11, после
миграции к имени Логика добавляется суффикс «-bot», чтобы Логика можно
было перенести.

Действие Измените имя бот в команде Выполнить задачу.

Сообщения для ознакомления

Эти сообщения отображаются в отчете Bot Scanner, Bot Migration Wizard и в «Помощнике по
миграции» после выполнения миграции боты. In such cases, the бот is successfully migrated but you
still have to manually verify the migrated боты as described in the following messages.
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Код: R101
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Сообщения 1. Действие Excel: переключиться на лист было перенесено.

Проверьте имя сеанса действия и тип, чтобы убедиться в
правильности имени сеанса общего доступа.

2. Действие Excel: Close action has been migrated.

Проверьте имя сеанса действия и тип, чтобы убедиться в
правильности имени сеанса общего доступа.

3. Действие Excel: Delete cells action has been migrated.

Проверьте имя сеанса действия и тип, чтобы убедиться в
правильности имени сеанса общего доступа.

4. Действие Excel: найти было перенесено.

Проверьте имя сеанса действия и тип, чтобы убедиться в
правильности имени сеанса общего доступа.

5. Действие Excel: Get multiple cells action has been
migrated.

Проверьте имя сеанса действия и тип, чтобы убедиться в
правильности имени сеанса общего доступа.

6. Действие Excel: Get single cells action has been
migrated.

Проверьте имя сеанса действия и тип, чтобы убедиться в
правильности имени сеанса общего доступа.

7. Действие Excel: Get cell address action has been
migrated.

Проверьте имя сеанса действия и тип, чтобы убедиться в
правильности имени сеанса общего доступа.

8. Действие Excel: получить имя столбца было перенесено.

Проверьте имя сеанса действия и тип, чтобы убедиться в
правильности имени сеанса общего доступа.

9. Действие Excel: Get row number action has been migrated.

Проверьте имя сеанса действия и тип, чтобы убедиться в
правильности имени сеанса общего доступа.

10. Действие Excel: Replace action has been migrated.
Проверьте имя сеанса действия и тип, чтобы убедиться в
правильности имени сеанса общего доступа.

11. Действие Excel: Run macro action has been migrated.
Проверьте имя сеанса действия и тип, чтобы убедиться в
правильности имени сеанса общего доступа.

12. Действие Excel: сохранить книгу было перенесено.
Проверьте имя сеанса действия и тип, чтобы убедиться в
правильности имени сеанса общего доступа.

13. Действие Excel: задать ячейку было перенесено.
Проверьте имя сеанса действия и тип, чтобы убедиться в
правильности имени сеанса общего доступа.
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Код: R102

Сообщение Системная переменная Имя ОС была перенесена.Проверьте
значение, возвращаемое для системной переменной Имя ОС в
перенесенном боте.

Значение, возвращаемое системной переменной Имя ОС, может
отличаться от версии 10.x/11.x.

Код: R103

Сообщение Действие Клонирование объектов было перенесено. Просмотрите
действие Распознавание изображений LeftClick в перенесенном
боте.

Migration of Object Cloning configured with play mode
Image with action MiddleClick has been migrated with Image
Recognition LeftClick action.

Код: R104

Сообщение Действие Операция строки — разделение было
перенесено.Просмотрите действие Операция строки — разделение
в перенесенном боте.

The Limit field is now divided into 2 fields: All Options
and Only. Limit has been migrated to Only since it has a
variable.

Код: R105

Сообщение Действие Интеграция приложений было перенесено. Проверьте
тип приложения Другое в перенесенном боте.

Поддерживается миграция действия Интеграция приложений с
типом приложения Другое.

Код: R106

Сообщение Действие OCR было перенесено. Подробнее см. в пакетной
документации Automation 360 по OCR.

ABBYY — единственный поддерживаемый модуль OCR.

Причина Only the ABBYY OCR engine is supported with Automation 360. Irrespective of
which OCR engine you have been using in Enterprise 11, after migration your
боты will run using only the ABBYY OCR engine.
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Действие Подробнее о пакете OCR см. в разделе Распознавание текста (OCR) пакет on
page 1712.

Код: R107

Сообщение Действие Электронная почта — соединение с сервером Exchange
было перенесено.

Сервер Exchange версии «Exchange 2013_SP1» будет перенесен
как «Exchange 2013». Убедитесь, что эта версия Сервера
Exchange будет работать с вашей системой.

Код: R114

Сообщение Действие Эмулятор терминала — подключить было перенесено.

Установленный тип подключения — SSH2, так как SSH1 не
поддерживается в A360.

Никаких дальнейших действий не требуется.

Причина Enterprise 11 и Enterprise 10 поддерживают тип подключения как SSH1,
так и SSH2. Automation 360 обновляется для поддержки только типа
подключения SSH2. However, your migrated боты that were configured
with SSH1 will work in Automation 360 and will be configured with the SSH2
connection type by default.

Код: R115

Сообщение Действие Эмулятор терминала — подключить было перенесено.

Теперь все боты используют настройку «Расширенная
технология». Протестируйте и выполните валидацию бота.

Причина В Enterprise 10 и Enterprise 11 вы можете выбрать, использовать ли
Расширенная технология для команды Эмулятор терминала —
подключить. Поскольку Automation 360 обновляется для поддержки только
Расширенная технология, все перенесенные боты будут настроены с
«Расширенная технология» для Эмулятор терминала — подключить по
умолчанию.

Код: R116

Сообщение The value of the Error Description variable in the migrated
bot may be different from version 10.x / 11.x.

Проверьте любое действие, которое использует значение
переменной Описание ошибки.

© 2023 Automation Anywhere. All rights reserved.     1336



    Automation Anywhere - Миграция в Automation 360

Код: R117

Сообщение Действие Рабочая нагрузка: вставить рабочую операцию было
перенесено.

Формат даты должен быть одинаковым в версиях 10.x / 11.x и
Automation 360.

Причина Поле Формат даты в действии Рабочая нагрузка: вставить рабочую
операцию использует формат даты по умолчанию.

Действие If the date format is different from the global value AADefaultDateFormat,
update the required format in the Workload: вставить рабочую операцию.

Код: R118

Сообщение Действие Назначить буферу обмена было перенесено.

Связанная переменная не существует в версии 10.x / 11.x и
была перенесена как строка в Automation 360.

Бот может не работать ожидаемым образом.

Код: R119

Сообщение Действие Операция переменной было перенесено.

Типы переменных не совпадают. Переменная была отключена в
перенесенном боте.

Никаких дальнейших действий не требуется.

Причина В Enterprise 11 если вы измените тип переменной (например, со строки на
словарь), бот проигнорирует изменение и перейдет к следующей строке.
Однако в Automation 360 изменение в переменной не поддерживается. So if
there is a change in variable type in the migrated бот, the variable is disabled to
maintain consistent behavior with Enterprise 11.
.

Код: R120

Сообщение Действие «Ожидать окно» было перенесено. Отрицательное
значение координаты X1 установлено на 0. Дальнейшие действия
не требуются.

Причина В Enterprise 10 и Enterprise 11 отрицательное значение для координаты
X1 поддерживается для действия Ожидать окно. В Automation 360
отрицательное значение не поддерживается, поэтому отрицательное
значение перенесенного бот устанавливается на 0 по умолчанию.
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Код: R121

Сообщение Действие «Ожидать окно» было перенесено. Отрицательное
значение координаты X2 установлено на 0. Дальнейшие действия
не требуются.

Причина In the Enterprise 10 and Enterprise 11, the negative value for X2 coordinate was
supported for Wait for Window action. In Automation 360, the negative value
is not supported, so, negative value of the migrated бот is set to 0 by default.

Код: R122

Сообщение Действие «Ожидать окно» было перенесено. Отрицательное
значение координаты Y1 установлено на 0. Дальнейшие действия
не требуются.

Причина В Enterprise 10 и Enterprise 11 отрицательное значение для координаты
Y1 поддерживается для действия Ожидать окно. В Automation 360
отрицательное значение не поддерживается, и отрицательное значение
перенесенного бот устанавливается на «0» по умолчанию.

Код: R123

Сообщение Действие «Ожидать окно» было перенесено. Отрицательное
значение координаты Y2 установлено на 0. Дальнейшие действия
не требуются.

Причина В Enterprise 10 и Enterprise 11 отрицательное значение для координаты
Y2 поддерживается для действия Ожидать окно. В Automation 360
отрицательное значение не поддерживается, и отрицательное значение
перенесенного бот устанавливается на «0» по умолчанию.

Код: R124

Сообщение Действие «Эмулятор терминала» было перенесено.

Проверьте имя сеанса действия, чтобы убедиться в
правильности имени сеанса общего доступа.

Код: R125

Сообщение Recorder action has been migrated. The object properties
with value greater than 64kb have been truncated. Review
the object properties value in the 'Recorder' action of the
migrated bot. No action is required if those properties are
not used in the search criteria. Message code: R125
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Код: R126

Сообщение 'Window title regex has been migrated.

Review the Window title regex in the migrated bot if the
window is not found during Bot run.

Код: R127

Сообщение Команда «IfImageReco-FileInFile» была перенесена.

.jpg, .jpeg, .jpe. .jfif, .bmp, .gif, .png — поддерживаемые
форматы файлов для действия поля «ImageFile1».

Код: R128

Сообщение Переменная со значением по умолчанию больше 64 КБ не
поддерживается. Значение сохраняется в текстовом файле и
назначается переменной во время запуска бота.

Код: R129

Сообщение Бот был перенесен.

Для запуска перенесенного бота требуется переменная словаря
в сопоставлении входных переменных действия «Выполнить
задачу». Проверьте временную переменную словаря, созданную
в родительском элементе и сопоставленную во входной
переменной.

Код: R130

Сообщение Действие «Выполнить задачу» было перенесено.

Переменная учетных данных небезопасным способом передается
типу переменной не учетных данных. Для повышения
безопасности передайте переменную учетных данных переменной
типа учетных данных.

Никаких дальнейших действий не требуется.

Код: R133
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Сообщение Действие с AAInstallationPath было перенесено.

Значение AAInstallationPath в перенесенном боте может
отличаться от версии 10.x/11.x.

Проверьте любое действие, которое использует значение
действия AAInstallationPath.

Код: R134

Сообщение Действие «Выполнить задачу» было перенесено.

Путь к дочернему боту в действии «Выполнить задачу»
передается через переменную во время выполнения. Значение
переменной должно передаваться по правильному пути к
дочернему боту во время выполнения бота.

Код: R135

Сообщение Действие «Захват экрана» было перенесено вместе с действием
«Записать в файл» для захвата изображения и описания ошибки.

Путь к файлу в действии «Захват экрана» передается через
переменную во время выполнения. Путь к файлу в действии
«Записать в файл»: $AAApplicationPath$/Temp/Error Handling/
ErrorMessage.txt. \
Никаких дальнейших действий не требуется.

Код: R136

Сообщение MetaBot с логикой был перенесен.

Одинаковое имя используется для папки активов MetaBot или
папки логики в версии 10.x/11.x. Логика MetaBot перенесена
путем добавления суффикса «-bot» к ее имени. Если у
какого-либо другого существующего бота такое же новое имя,
бот будет перезаписан.

Посмотрите перемещенный бот.

Code R137

Message Metabot with logic has been migrated.

This bot has been migrated. The migrated bot has a circular
dependency with another bot. Review the bot dependencies in
the migrated bot and update the missing dependencies.

Review the migrated bot.
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Код: R140

Сообщение The Value of the Error Line Number in the migrated bot may
be different from the one in version 10.x/11.x. Review any
action that uses the value of the Error Line Number in the
migrated bot. Message code:R140

Сообщения об ошибке

Эти сообщения отображаются в отчете Bot Scanner и Bot Migration Wizard. Эти сообщения
отображаются, когда миграция бот не удалась.

Код: E101

Сообщение Невозможно выполнить миграцию бота, так как у него есть
дочерний бот, использующий неподдерживаемое действие или
системную переменную.

Причина Невозможно перенести дочерний бот, использующий команду, которая
в настоящее время не поддерживается для миграции. В результате,
родительские боты, использующие этого дочернего бот, также не могут быть
перенесены.

Действие Чтобы перенести родительские боты, удалите связи с дочерним бот из
родительского бот. Затем перенесите этот родительский бот.
Чтобы просмотреть неподдерживаемые команды, которые используются
в дочернем боты, перейдите к списку боты, которые не могут быть
перенесены, и щелкните имя дочернего бот.

Код: E104

Сообщение Невозможно выполнить миграцию бота. The Object Cloning
command which automates Flash application is not supported
in Automation 360. Delete the Object Cloning command which
automates Flash application in Enterprise 10.x/Enterprise
11.x bot and then migrate. Message code: E104

Код: E106

Сообщение Невозможно выполнить миграцию бота.

Миграция действия MetaBot с экранами в режиме запуска
«Текст» еще не поддерживается.

Note:  This message is applicable only for Automation 360 v.25 and earlier
releases.
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Код: E109

Сообщение Невозможно выполнить миграцию бота.

Миграция вызова REST API с использованием веб-службы SOAP с
проверкой подлинности с помощью сертификата клиента еще не
поддерживается.

Код: E110

Сообщение Невозможно выполнить миграцию бота.

Миграция типа данных ДЕСЯТИЧНАЯ БАЙТОВАЯ СТРОКА ОКТЕТОВ еще
не поддерживается.

Код: E112

Сообщение Невозможно выполнить миграцию бота.

Миграция вызова REST API с использованием действия
Веб-служба SOAP с помощью Внешнего XML еще не
поддерживается.

Код: E113

Сообщение Невозможно выполнить миграцию бота.

Миграция вызова REST API с использованием действия
Веб-служба SOAP с помощью Внутреннего XML еще не
поддерживается.

Код: E114

Сообщения 1. Невозможно выполнить миграцию бота.

Миграция действия Операция переменной — сброс системной
переменной еще не поддерживается.

2. Невозможно выполнить миграцию бота.

Миграция действия Интернет — IntCon еще не
поддерживается.

Код: E115

Сообщение Невозможно выполнить миграцию бота.

Миграция действия Операция переменной, которое сбрасывает
системную переменную $WorkItem$, не поддерживается.
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Сброс системной переменной $WorkItem$ не поддерживается для команды
Операция переменной.

Используйте операцию Строка > Присвоить и присвойте пустую строку
системной переменной $WorkItem$ вместо сброса.

Код: E116

Сообщение Невозможно выполнить миграцию бота.

Миграция действия Операция переменной, которое сбрасывает
системную переменную $WorkItemResult$, не поддерживается.

Причина Сброс системной переменной $WorkItemResult$ не поддерживается для
команды Операция переменной.

Действие Используйте операцию Строка > Присвоить и присвойте пустую строку
системной переменной $WorkItemResult$ вместо сброса.

Код: E118

Сообщение Создайте учетные данные или ячейку в Automation 360 перед
миграцией бота версии 10.x/11.x.

Невозможно выполнить миграцию переменных учетных данных
для MetaBot-DLL, так как соответствующие учетные данные или
ячейка отсутствуют в Control Room.

Причина Невозможно выполнить миграцию связанной переменной учетных данных
Metabot-DLL, так как связанные учетные данные или ячейка отсутствуют в
Control Room Enterprise 11.

Действие Вручную создайте учетные данные или ячейку в Automation 360, а затем
перенесите бот.

Код: E119

Сообщение Недопустимый путь к боту.

Перед миграцией измените путь к боту в версии 10.x/11.x и
убедитесь, что бот работает.

Путь, определенный в действии Выполнить задачу с помощью
$AAApplicationPath$, отсутствует в допустимой папке
репозитория.

Причина бот Enterprise 11 или Enterprise 10 использует недопустимый путь в команде
«Выполнить задачу» дочернего бот.

Действие Для миграции бот измените бот Enterprise 11, чтобы после
AAApplicationPath указывался действительный путь дочернего бот.
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Код: E120

Сообщение Недопустимый путь к боту.

Перед миграцией измените путь к боту в версии 10.x/11.x и
убедитесь, что бот работает.

Путь, определенный в действии If - TaskSuccessful с помощью
$AAApplicationPath$, отсутствует в допустимой папке
репозитория.

Причина бот Enterprise 11 или Enterprise 10 использует недопустимый путь в команде
If - TaskSuccessful дочернего бот.

Действие Для миграции бот измените бот Enterprise 11, чтобы после
AAApplicationPath указывался действительный путь дочернего бот.

Код: E121

Сообщение Недопустимый путь к боту.

Перед миграцией измените путь к боту в версии 10.x/11.x и
убедитесь, что бот работает.

Путь, определенный в действии If - TaskSuccessful с помощью
$AAApplicationPath$, отсутствует в допустимой папке
репозитория.

Причина бот Enterprise 11 или Enterprise 10 использует недопустимый путь в команде
If - TaskSuccessful дочернего бот.

Действие Для миграции бот измените бот Enterprise 11, чтобы после
AAApplicationPath указывался действительный путь дочернего бот.

Код: E122

Сообщение Недопустимый путь к боту.

Перед миграцией измените путь к боту в версии 10.x/11.x и
убедитесь, что бот работает.

Путь, определенный в действии ElseIf - TaskUnsuccessful с
помощью $AAApplicationPath$, отсутствует в допустимой папке
репозитория.

Причина бот Enterprise 11 или Enterprise 10 использует недопустимый путь в команде
ElseIf - TaskUnsuccessful дочернего бот.

Действие Для миграции бот измените бот Enterprise 11, чтобы после
AAApplicationPath указывался действительный путь дочернего бот.

Код: E123
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Сообщение Недопустимый путь к боту.

Перед миграцией измените путь к боту в версии 10.x/11.x и
убедитесь, что бот работает.

Путь, определенный в действии ElseIf - TaskSuccessful с
помощью $AAApplicationPath$, отсутствует в допустимой папке
репозитория.

Причина бот Enterprise 11 или Enterprise 10 использует недопустимый путь в команде
ElseIf - TaskSuccessful дочернего бот.

Действие Для миграции бот измените бот Enterprise 11, чтобы после
AAApplicationPath указывался действительный путь дочернего бот.

Код: E124

Сообщение Недопустимый формат значения, переданного функции DLL.

Измените бота в версии 10.x/11.x перед миграцией.

Проверьте переменную массива/списка и значение
столбца/индекса, переданные в функцию DLL и обновите бота
10.x/11.x.

Код: E125

Сообщение Измените бота в версии 10.x/11.x перед миграцией.

Обновите бот версии 10.x / 11.x, чтобы включить связанные
переменные для действия Назначить из буфера обмена.
Связанная переменная не найдена.

Код: E127

Сообщение Измените бота в версии 10.x/11.x перед миграцией.

Типы переменных не совпадают или были изменены.

Обновите тип переменной в действии Операция переменной в
версии бота 10.x/11.x.

Код: E128

Сообщение Невозможно выполнить миграцию бота.

Миграция «MetaBot с экранами» с использованием технологии
Silverlight еще не поддерживается.

Код: E129
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Сообщение Невозможно выполнить миграцию бота.

Миграция «MetaBot с экранами», захваченного с помощью
браузера Edge, еще не поддерживается.

Код: E130

Сообщение Невозможно выполнить миграцию бота.

Миграция «MetaBot с экранами», захваченного с помощью
браузера Firefox, еще не поддерживается.

Код: E131

Сообщение Невозможно выполнить миграцию бота.

Миграция «MetaBot с экранами» с действием
«GetAllChildrenData» еще не поддерживается.

Код: E132

Сообщение Невозможно выполнить миграцию бота.

Миграция «MetaBot с экранами» с действием «GetVisibility»
еще не поддерживается.

Код: E133

Сообщение Невозможно выполнить миграцию бота.

Миграция «MetaBot с экранами» со связанными объектами еще не
поддерживается.

Код: E134

Сообщение Невозможно выполнить миграцию бота.

Миграция «MetaBot с экранами» в режиме воспроизведения как
координат для связанных объектов еще не поддерживается.

Код: E135

Сообщение Невозможно выполнить миграцию бота.

Миграция «MetaBot с экранами» в режиме запуска
воспроизведения как изображения для связанных объектов еще
не поддерживается.
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Код: E136

Сообщение Невозможно выполнить миграцию бота.

Миграция действия «Клонирование объектов» с помощью браузера
Edge еще не поддерживается.

This bot cannot be migrated. The Object Cloning command
which automates Legacy Edge browser is not supported in
Automation 360 . Delete the object cloning command which
automates Edge Legacy browser in 10.x/11/x bot and then
migrate. Message code: E136

Код: E137

Сообщение Невозможно выполнить миграцию бота.

Миграция действия «Клонирование объектов» с помощью браузера
Firefox еще не поддерживается.

Код: E138

Сообщение Невозможно выполнить миграцию бота.

Миграция действия «Клонирование объектов» с Silverlight еще
не поддерживается.

Код: E139

Сообщение Невозможно выполнить миграцию бота.

Миграция действия «Клонирование объектов» с действием
«GetDataofAllchildren» еще не поддерживается.

Код: E140

Сообщение Невозможно выполнить миграцию бота.

Миграция действия «Эмулятор терминала — подключить» с
помощью «японской кодовой страницы катакана (50939)» еще не
поддерживается.

Код: E141
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Сообщение Невозможно выполнить миграцию бота.

Миграция действия «Эмулятор терминала — подключить» с
использованием «японской кодовой страницы катакана (51932)»
еще не поддерживается.

Код: E142

Сообщение Невозможно выполнить миграцию бота.

Миграция действия «Эмулятор терминала — подключить» с
использованием «японской кодовой страницы JIS (20932)» еще
не поддерживается.

Код: E143

Сообщение Невозможно выполнить миграцию бота.

Миграция действия «Эмулятор терминала — подключить» с
использованием «японской кодовой страницы JIS (50220)» еще
не поддерживается.

Код: E144

Сообщение Невозможно выполнить миграцию бота.

Миграция действия «Эмулятор терминала — подключить» с
использованием «японской кодовой страницы JIS (50221)» еще
не поддерживается.

Код: E145

Сообщение Невозможно выполнить миграцию бота.

Миграция действия «Эмулятор терминала — подключить» с
использованием «японской кодовой страницы JIS (50222)» еще
не поддерживается.

Код: E146

Сообщение Невозможно выполнить миграцию бота.

Миграция действия «Эмулятор терминала — подключить» с
использованием «японской кодовой страницы катакана (50930)»
еще не поддерживается.

Код: E147
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Сообщение Невозможно выполнить миграцию бота.

Миграция действия «Эмулятор терминала — подключить» с
использованием «японской кодовой страницы катакана (20290)»
еще не поддерживается.

Код: E148

Сообщение Невозможно выполнить миграцию бота.

Миграция действия «Эмулятор терминала — подключить»
с использованием «кодовой страницы "США-Канада и
Япония" (50931)» еще не поддерживается.

Код: E149

Сообщение Невозможно выполнить миграцию бота.

Миграция команды «Обход» с типом «Все» не поддерживается.

Код: E150

Сообщение Невозможно выполнить миграцию бота.

Указанный MetaBot недоступен в данном расположении. Укажите
допустимого MetaBot или расположение в версии 10.x/11.x и
повторите попытку.

Код: E151

Сообщение Невозможно выполнить миграцию бота.

Миграция действия $IsCognitiveCaptureSuccess$ не
поддерживается.

Код: E152

Сообщение Невозможно выполнить миграцию бота.

Измените переменную типа «Пароль» в боте версии 10.x/11.x
перед миграцией.

Миграция команды с переменной типа «Пароль» не
поддерживается. Это действие не поддерживает переменную
хранилища учетных данных.

Код: E153

© 2023 Automation Anywhere. All rights reserved.     1349



    Automation Anywhere - Миграция в Automation 360

Сообщение Невозможно выполнить миграцию бота.

Перед миграцией измените тип переменной поля действия
SMARTWndCtrl в боте версии 10.x/11.x.

Не поддерживается миграция действия SMARTRecorder
«SMARTWndCtrl» с полем «SetDateRange_NotSupportedAction»
типа «Строка».

Код: E154

Сообщение Невозможно выполнить миграцию бота.

The migration of 'MetaBot with Screens' with 'play mode as
image for linked objects' and 'play mode as object for main
objects' is not yet supported.

Код: E155

Сообщение Невозможно выполнить миграцию бота.

The migration of 'MetaBot with Screens' with 'play mode as
image for linked objects' and 'play mode as text for main
objects' is not yet supported.

Код: E156

Сообщение Невозможно выполнить миграцию бота.

The migration of 'MetaBot with Screens' with 'play mode as
object for linked objects' and 'play mode as image for main
objects' is not yet supported.

Код: E157

Сообщение Невозможно выполнить миграцию бота.

The migration of 'MetaBot with Screens' with 'play mode as
object for linked objects' and 'play mode as text for main
objects' is not yet supported.

Код: E159

Сообщение Невозможно выполнить миграцию бота.

The migration of 'MetaBot with Screens' with 'play mode as
text for linked objects' and 'play mode as object for main
objects' is not yet supported.
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Код: E160

Сообщение Невозможно выполнить миграцию бота.

The migration of 'MetaBot with Screens' with 'play mode as
text for linked objects' and 'play mode as text for main
objects' is not yet supported.

Код: E160

Сообщение Невозможно выполнить миграцию бота.

The migration of 'MetaBot with Screens' with 'play mode as
coordinate for linked objects' and 'play mode as text for
main objects' is not yet supported.

Код: E163

Сообщение Network Error: Migration failed due to loss of connectivity
between Control Room and Bot Runner machine.

Код: E164

Сообщение Невозможно выполнить миграцию бота.

The migration of 'MetaBot with Screens' with 'play mode as
text' and having Import Dataset command with action other
than GetText, SetText, DoubleClick, LeftClick and RightClick
is not yet supported.

Код: E165

Сообщение Невозможно выполнить миграцию бота.

The migration of 'MetaBot with Screens' with 'play mode
as text' and having any OCR engine other than 'Abbyy' or
'Tesseract' will use 'Abbyy' OCR engine after migration.

Сообщения о преобразовании или сканировании Internet Explorer

Данные сообщения отображаются в отчете Bot Scanner, когда запускаются или сканируются боты,
использующие Internet Explorer, и эти боты не переносятся в другие поддерживаемые браузеры.

Код: R1001
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Сообщение В свойстве «Расположение программы/файла» этого бота
используется переменная. Если переменная указывает на
Internet Explorer, обновите ее так, чтобы она указывала на
браузер Microsoft Edge на базе Chromium. Если переменная
не указывает на Internet Explorer, дальнейшие действия не
требуются.

Код: R1002

Сообщение Такие компоненты браузера, как строка меню, строка
состояния, строка избранного, командная строка и другие
компоненты, не относящиеся к веб-странице, отличаются в
каждом браузере. Это может повлиять на захваченные экраны в
<PACKAGE_NAME - ACTION_NAME>.

При необходимости рекомендуется проверить и снова захватить
экран.

Код: R1003

Сообщение RegEx variable used in the window title seems to have
partial text corresponding to 'Internet Explorer' hence the
title may not get converted as per 'Microsoft Edge' text
that is used in the Edge browser window.

Рекомендуется использовать текст «Internet Explorer» как
единое целое в переменной регулярного выражения.

Differences while migrating APIs from Enterprise 11/Enterprise 10
to Automation 360
When you migrate from Enterprise 11 to Automation 360, review any Control Room APIs migration issues
and their workarounds.
One difference between the Enterprise 11 and Automation 360 versions occurs in the Credential Value
API - Get attributevalues.

GET https://{{ControlRoomURL}}/v2/credentialvault/credentials/
{credentialId}/attributevalues

In Automation 360, the CredentialAttribute object is not available in the response of GET
 attributevalues API. If you are using any parameters in this object in your bot logic then you must
modify your response parsing logic and use GET /v2/credentials/{id} (See Credential Vault API) to
consume those parameters.
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Sample responses for the GET attributevalues for both Enterprise 11 and Automation 360 versions:

Enterprise 11 Automation 360

{
 {
  "list": [{
    "id": "2221",
    "credentialAttributeId":
 "9271",
    "value": "LNC2021132D",
    "createdBy": "21",
    "createdOn":
 "2021-09-29T12:37:48.765Z",
    "updatedBy": "131",
    "updatedOn":
 "2021-10-18T20:47:58.027Z",
    "version": "3",
    "credentialAttribute": {
      "id": "2277",
      "name": "ABCD_Account",
      "description": "",
      "userProvided": false,
      "masked": false,
      "createdBy": "77",
      "createdOn":
 "2021-09-29T12:37:48.638Z",
      "updatedBy": "77",
      "updatedOn":
 "2021-09-29T12:37:48.638Z",
      "version": "0",
      "passwordFlag": false
    }
  }]
}

{
  "list": [{
    "id": "4008",
    "credentialAttributeId":
 "1622",
    "value": "LNC2021132D",
    "createdBy": "21",
    "createdOn":
 "2021-09-29T12:37:48.765Z",
    "updatedBy": "274",
    "updatedOn":
 "2021-10-18T20:47:58.027Z",
    "version": "3",
    "password": false
  }]
}

Миграция боты Community Edition
Боты, созданные в среде Enterprise 11 Community Edition, необходимо перенести в Automation
360 Community Edition, чтобы пользователи могли использовать эти боты в Automation 360. Вы
используете пакет миграции Бот, доступный в Automation 360 Community Edition для ручной
миграции боты.
Перед началом миграции боты выполните следующие действия.
• Используйте утилиту Bot Scanner, чтобы оценить вероятность успешной миграции боты Enterprise

11.

Обзор Bot Scanner on page 1166
• Получите доступ к Automation 360 Community Edition.
• Зарегистрируйте устройство в Automation 360 Community Edition для запуска боты.

Установка Bot Agent и регистрация устройств on page 1046

Эта процедура позволяет перенести один бот за раз. Чтобы перенести все боты в одной папке,
можно создать сложный бот путем итерации файлов в папке в рамках цикла или добавить несколько
действий Перенести бот для каждого файла .atmx, который вы хотите перенести.
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Important:  Если бот имеет зависимости от других боты, то сначала необходимо перенести
зависимые боты, а затем родительский бот. Например, родительский бот  main.atmx имеет
зависимость от child1.atmx, который в свою очередь имеет зависимость от child2.atmx,
добавьте действия Перенести бот в следующем порядке: child2.atmx, {{child1.atmx}} и
{{main.atmx}}.

1. Выполните вход в Automation 360 Community Edition.
2. Используйте пакет миграции Бот, чтобы перенести боты.

a) Щелкните Автоматизация на левой панели.
b) Щелкните Создать > Бот, укажите необходимые данные и щелкните Создать и

редактировать.
c) Разверните пакет Миграция ботов и дважды щелкните по действию Перенести бот.
d) Выберите Файл рабочего стола в разделе Путь к файлу бота.
e) Введите полный путь к файлу Enterprise 11 .atmx, который необходимо перенести.
f) Optional: Введите путь к папке вывода в поле Путь к папке вывода, чтобы указать место

сохранения информации о преобразовании пакетов и ошибках.
Для каждого перенесенного бот создается отчет, содержащий соответствующую
информацию.

g) Не отменяйте выбор параметра Заменить файл, если он существует (настройка по
умолчанию), если вы хотите, чтобы этот перенесенный бот перезаписал любые боты с
таким же именем в среде Automation 360 Community Edition.

h) Сохраните бот.
i) Запустите бот на подключенном устройстве, чтобы выполнить миграцию.

Перенесенные боты загружаются в личный репозиторий пользователя Automation 360,
выполнившего миграцию. Миграция доступна только для успешно перенесенных боты.
Используйте отчеты в указанном пути к папке вывода, чтобы просмотреть ошибки миграции.

Related tasks
Scan Enterprise 11 or 10 боты using Bot Scanner on page 1168
Перед миграцией в Automation 360 важно проверить готовность боты к миграции. Просканируйте
боты с помощью Bot Scanner и проанализируйте созданный отчет для получения информации о
командах и переменных, используемых в этих боты, а также сведений о том, сколько из команд и
переменных поддерживается для миграции.
Related reference
Бот migration пакет on page 1437
The Bot migration пакет enables you to migrate Enterprise 10 and Enterprise 11 боты to Automation
360 format. The пакет also enables you to convert Enterprise 10, Enterprise 11, or Automation 360
боты that use Internet Explorer to Microsoft Edge with IE mode. This пакет is used internally by the Bot
Migration Wizard and the Update Bot wizard.

Миграция в Automation 360 IQ Bot
Миграция — это процесс перехода с более ранних версий IQ Bot (Enterprise 11.x, 6.x или 5.x)
на последнюю версию Automation 360 IQ Bot. Сюда входит репликация существующих базы
данных и репозитория, преобразование боты в формат Automation 360 и миграция всех обучаемых
экземпляров.
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Проверьте готовность к миграции

Функции Automation 360 IQ Bot и функциональность такие же, как и у Enterprise 11 IQ Bot.
Существующее содержимое Enterprise 11 также применяется к Automation 360 IQ Bot.
• Вы можете перейти на любую версию Automation 360 IQ Bot без каких-либо ограничений. Однако

убедитесь, что для миграции вы используете помощник по миграции базы данных целевой
версии.
Например, если вы хотите перейти на версию Automation 360 IQ Bot (сборка 11513), необходимо
использовать помощник по миграции базы данных для Automation 360 IQ Bot (сборка 11513),
который доступен как отдельная утилита в папке установки Automation 360 IQ Bot.

• Сравните некоторые ключевые функции моделей развертывания Automation 360 IQ Bot с
выпуском IQ Bot.

Матрица сравнения функций Automation 360 IQ Bot on page 740
• Просмотрите информацию о совместимости версий IQ Bot.

Automation 360 IQ Bot version compatibility on page 745
• Obtain the migration license: Получить лицензию на миграцию on page 1181
• Перед миграцией с IQ Bot 11.x на On-Premises Automation 360 IQ Bot убедитесь, что вы загрузили

последнюю версию помощника по миграции базы данных с сайта поддержки Automation
Anywhere.
Этот инструмент позволяет осуществлять миграцию данных и поддерживается в указанных ниже
версиях Microsoft SQL Server.
• Microsoft SQL Server 2019 15.0 Developer Edition и Express Edition
• Microsoft SQL Server 2016 13.0 Express Edition
• Microsoft SQL Server 2012 Express Edition

Note:  Помощник по миграции баз данных не поддерживает службу баз данных Azure PaaS. Если
вы используете службу баз данных Azure PaaS, необходимо скопировать все базы данных IQ Bot
в любую из перечисленных выше поддерживаемых версий и запустить помощник по миграции
баз данных. Унифицированные базы данных, созданные с помощью помощник по миграции баз
данных, можно затем загрузить обратно в службу баз данных Azure PaaS.

• При миграции IQ Bot с версии 11.x на On-Premises Automation 360 IQ Bot рекомендуется
использовать кластер из 3 узлов, чтобы обеспечить высокую доступность (HA) для IQ Bot.
High availability and disaster recovery overview

• Для аварийного восстановления (DR) RabbitMQ v3.8.18 рекомендуется использовать одинаковое
количество узлов на основной и дополнительной площадках, чтобы обеспечить одинаковую
возможность обработки нагрузки.
Аналогичным образом настройка кластера RabbitMQ v3.8.18 на дополнительной площадке должна
повторять настройку кластера на основной площадке.
Disaster recovery deployment model

Сведения о конфигурации кластера RabbitMQ v3.8.18 с автоматическим восстановлением, см. в
RabbitMQ Cluster Configuration with Auto-recovery (A-People login required)
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Выбор способа миграции

Выберите путь миграции в зависимости от версии IQ Bot, которую вы используете в
настоящее время, и модели развертывания Automation 360 IQ Bot, которая отвечает вашим
бизнес-требованиям.

Important:  В более ранних версиях IQ Bot было создано пять баз данных, а в Automation 360 IQ
Bot создана единая унифицированная база данных. Поэтому перед запуском миграции обязательно
создайте резервные копии существующих баз данных IQ Bot.

Если у вас указанная версия Выполните эту процедуру миграции

IQ Bot 11.3.4 (или более
поздние версии)

Выполните миграцию в On-Premises или Cloud Automation 360
IQ Bot.
1. Migrate earlier IQ Bot versions to Automation 360 IQ Bot On-

Premises on page 1358
2. Migrate from Automation 360 IQ Bot On-Premises to Cloud on

page 1360
Перед миграцией на Cloud IQ Bot установите последнюю
версию On-Premises Automation 360 IQ Bot.

IQ Bot 6.5.x Миграцию On-Premises Automation 360 IQ Bot можно
выполнить только с IQ Bot Version 11.3.4.
1. Обновите IQ Bot Version 6.5 до IQ Bot Version 11.3.4

Update IQ Bot from 6.5 or earlier to 11.3.4

2. Migrate earlier IQ Bot versions to Automation 360 IQ Bot On-
Premises on page 1358

3. Migrate from Automation 360 IQ Bot On-Premises to Cloud on
page 1360
Перед миграцией на Cloud IQ Bot установите последнюю
версию On-Premises Automation 360 IQ Bot.

IQ Bot 5.3.x (или более
ранние версии)

1. Выполните обновление до IQ Bot Version 6.5
Update IQ Bot from 5.3.x or 6.0 to 6.5

2. Обновите IQ Bot Version 6.5 до Version 11.3.4
Update IQ Bot from 6.5 or earlier to 11.3.4

3. Migrate earlier IQ Bot versions to Automation 360 IQ Bot On-
Premises on page 1358

4. Migrate from Automation 360 IQ Bot On-Premises to Cloud on
page 1360
Перед миграцией на Cloud IQ Bot установите последнюю
версию On-Premises Automation 360 IQ Bot.
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Related concepts
Install and update Automation 360 IQ Bot on page 1073
This collection of topics guide you through the process of installing or setting up Automation 360 IQ Bot
On-Premises and Cloud.

Prepare for IQ Bot migration
Perform these tasks before you migrate to Automation 360 IQ Bot (On-Premises) from an earlier IQ Bot
version (from Enterprise 6.x through 11.x).
1. If you are currently using any of the earlier versions of Automation Anywhere Enterprise (10.x or

11.x), ensure you migrate to the latest Automation 360 version.
Миграция в Automation 360 on page 1133

2. Ensure the Automation 360 version corresponds to the Automation 360 IQ Bot that you are installing.
Automation 360 IQ Bot version compatibility on page 745

3. Migrate to the latest Automation 360 IQ Bot On-Premises from IQ Bot Version 11.3.4 or later versions.
If you are currently using any of the earlier IQ Bot versions (5.3.x), you must first perform these
tasks:
a) Update to IQ Bot Version 6.5.

См. Update IQ Bot from 5.3.x or 6.0 to 6.5

b) Update IQ Bot Version 6.5 to IQ Bot Version 11.3.4 before migrating to Automation 360 IQ Bot
On-Premises.
См. Update IQ Bot from 6.5 or earlier to 11.3.4

4. Back up your existing IQ Bot databases.
In the earlier IQ Bot versions, five databases were created. With Automation 360 IQ Bot On-Premises
Сборка 2545, a single unified database is created.
a) Ensure you back up all five databases:

• AliasData
• ClassifierData
• Configurations
• FileManager
• MLData

b) Uninstall any earlier IQ Bot versions.
Uninstalling an existing IQ Bot build does not delete the databases.
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5. Install Database Migration Assistant.
a) Log into Automation Anywhere support site and download the Database Migration Assistant:

A-People Downloads page (Login required)

Note:  Ensure that OBDC Driver version 17.0 for SQL Server is available on your system
before you run the Database Migration Assistant.

b) Double-click the file to run Database Migration Assistant.
c) Click Next to continue.
d) Accept the license agreement. and click Next.
e) In the Database Configuration screen, enter your existing IQ Bot database host name and

credentials, and click Next.

Note:  The Сервер SQL Browser service must be running if you want to use the full name of the
Сервер SQL as the host name.

f) (Optional) Click Browse to change the default installation folder for the Database Migration
Assistant.

g) Click Install.
After a successful installation, a new database called IQBot is created. You can use the following
path to review the log files:
C:\Users\Public\Documents\Migration_Assistant_Logs

Note:  After migration to Automation 360 IQ Bot completes, output files processed in IQ Bot 11x will
not be available for download through the IQ Bot пакет in the Control Room.

Migrate earlier IQ Bot versions to Automation 360 IQ Bot On-
Premises
Migrate from an earlier IQ Bot version (from Enterprise 6.x through 11.x) to Automation 360 IQ Bot (On-
Premises) for the latest features and enhancements.
1. Download Automation 360 IQ Bot

a) Log into Automation Anywhere support site to download the latest Automation 360 IQ Bot build:
A-People Downloads page (Login required)

b) Extract (unzip) the Automation_Anywhere_IQ_Bot_A2019_(Build number) folder and run the
following .bat files:
1. CleanupRabbitMQandErlang.bat

2. CleanupRabbitMQErlangPython.bat

3. UninstallPython.bat

4. UninstallPython385.bat

These files remove the registry entries of RabbitMQ v3.8.18, Erlang/OTP relevant IQ Bot Python.
No other Python versions are affected.

c) Restart your machine.

© 2023 Automation Anywhere. All rights reserved.     1358

https://apeople.automationanywhere.com/s/downloads
https://apeople.automationanywhere.com/s/downloads


    Automation Anywhere - Миграция в Automation 360

2. Install Automation 360 IQ Bot
a) Open Automation_Anywhere_IQ_Bot_A2019_(Build number) folder and run the following files

again:
1. CleanupRabbitMQandErlang.bat

2. CleanupRabbitMQErlangPython.bat

3. UninstallPython.bat

4. UninstallPython385.bat

This procedure removes any empty folders from RabbitMQ v3.8.18, Erlang, and Python.
b) Install the Automation 360 IQ Bot build.
c) During installation, specify the same host name where the IQBot database was created.

Automation 360 IQ Bot automatically connects to the IQBot database that was created by the
Database Migration Assistant before migrating the data.

d) When the installation completes, unregister IQ Bot Enterprise 11.
Unregistering IQ Bot from the Control Room

Automation 360 IQ Bot automatically connects to the IQBot database that was created by the
Database Migration Assistant before migrating the data.

e) Clear the browser cache.
f) (Optional) Restart the Cognitive Console service if IQ Bot fails to load.

3. Register Automation 360 IQ Bot
a) Register IQ Bot A360.x with the Control Room.

x refers to the latest version of Automation 360 IQ Bot.
Registering IQ Bot with the Control Room

Troubleshooting:
• If the login page is not displayed after registering IQ Bot A360.x, restart the Control Room

services (Control Room and Control Room Reverse proxy).
• If none of the domains or dashboards are displayed when you log in to Automation 360 IQ Bot

after a successful migration, perform the following steps:
• Press the F12 key and click the Network tab to view the APIs.

If the APIs are unauthorized or display an error message, restart the IQ Bot service.
• If the боты are not displayed in the learning instances, clear the browser cache.

b) After the registration, restart the Automation Anywhere Cognitive Application service.
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4. Modify the output file name
a) After the data is migrated, ensure you modify the name of the output .csv file.

The output .csv file in Automation 360 IQ Bot contains additional characters. If you are using
the download command, use the following instructions to edit the output .csv filename:
• Remove the brackets [ ].
• Replace the underscore (_) character with a hyphen (–).
• Replace spaces with underscore (_).

For example, if the output .csv filename is [sales-7d6 961f3d28]_Invoice.tiff,
rename it as sales-7d6_961f3d28-Invoice.tiff.

5. Verify the migrated data
a) Log in to the Automation 360 IQ Bot as a newly created IQ Bot user.
b) Review the data displayed on the Dashboard to ensure that the IQ Bot 11.3.x data has been

migrated.
c) You can also verify the migrated data by checking the following pages:

• Экземпляры для обучения
• Домены
• Bot Pages

Ensure that the current Распознавание текста (OCR) version is supported in Automation 360 IQ Bot.
• ABBYY FineReader Engine - 12.2, 12.3, or 12.4 (use the version provided in the installation folder)

Note:  To upgrade the OCR version, download the OCR package to the installation folder.

• Tesseract OCR - 4
• Google Vision API - version is updated automatically to match current release
• Microsoft Azure Computer Vision OCR engine - 2.0 or 3.2
• Tegaki API - check with your Cogent Labs sales representative

Related information
IQ Bot migration with keys stored in external vault (Login required)

Migrate from Automation 360 IQ Bot On-Premises to Cloud
IQ Bot Cloud offers all the Automation 360 IQ Bot On-Premises features through a browser-based
interface.
• Migrate Control Room before migrating to IQ Bot Cloud. If you have Control Room available on Cloud,

you can migrate to IQ Bot Cloud.
• Install the latest version of Automation 360 IQ Bot On-Premises before migrating to IQ Bot Cloud.

См. раздел Migrate earlier IQ Bot versions to Automation 360 IQ Bot On-Premises on page 1358.
• Ensure that an active IQ Bot Cloud instance with the same version is available.
• If there is an incorrect IQ Bot registration data, ensure that you remove it before creating the correct

registration data.

Keep in mind the following considerations when migrating from Automation 360 IQ Bot On-Premises to IQ
Bot Cloud:
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• IQ Bot Cloud is a single-node instance.
Before you start the migration, ensure that you review the document processing and concurrency
requirements. Cluster setup is not supported on IQ Bot Cloud.

• Configuration files cannot be accessed in the IQ Bot Cloud.
Custom Распознавание текста (OCR) settings in configuration files have to be uploaded into
Automation 360 IQ Bot On-Premises database before migration.
How to change OCR Settings in IQ Bot (A-People login required)

• Python scripting is restricted to specific libraries on IQ Bot Cloud.
Customer-specific Python files, specific libraries, and methods are not allowed in IQ Bot Cloud.
List of supported Pandas Libraries in Automation 360 IQ Bot (A-People login required)

• Role-Based Access Control (RBAC) setup that you have configured on the Automation 360 IQ Bot On-
Premises is not migrated to IQ Bot Cloud.
См. раздел RBAC in Control Room on page 32.

• Transfer the .iqba files to IQ Bot Cloud.
Any custom roles that you have created are removed before .iqba files are created. Ensure that you
add these roles after transferring the .iqba files to IQ Bot Cloud.

Users have the following options to upload the .iqba file to IQ Bot Cloud:
• Click Migration Utility > Export/Import in Automation 360 IQ Bot On-Premises (starting from Build

5931).
Migrate learning instances on page 1362

• Migrate learning instance in IQ Bot Cloud through API. Use the Migration Utility feature to generate
.iqba learning instance files, transfer them between systems, and import them into new IQ Bot
databases.
Migrate Learning Instances in IQ Bot Cloud through API (A-People login required)

1. Export custom domains from Automation 360 IQ Bot On-Premises to IQ Bot Cloud.
Custom domains in IQ Bot on page 2551

2. Use the Migration Utility feature to export learning instances from the Automation 360 IQ Bot On-
Premises version.

3. Use the IQ Bot UI or API to upload the .iqba file to IQ Bot Cloud.
4. Open IQ Bot Cloud and import learning instances by using Migration Utility.

All your learning instances from Automation 360 IQ Bot On-Premises are imported and available on IQ Bot
Cloud.

Important:  Review the following points:
• If the learning instances are large, migrate them one at a time to avoid timeouts.
• If you use custom domains, migrate them.
• Import the custom domains in the same order as they were in in the Automation 360 IQ Bot On-

Premises version.
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Migrate learning instances
Use the Automation 360 IQ Bot Migration Utility feature to migrate (export and import) learning instances
between environments to avoid recreating similar learning instances and easily manage the lifecycle of the
associated боты.
The learning instances can be migrated by the IQ Bot administrator or a user associated with custom
role that has migration permissions. View a list of available learning instances by using IQ Bot >
Administrator > Migration to go to the Migration Utility page.

What is transferred across environments

When you export a learning instance, an IQBA file is created with the following assets:
• Группы документов
• Training documents (one per document group)
• RPA боты (one per document group)
• Custom domain (contact Automation Anywhere Enterprise support for assistance with transferring this

type of asset)

Note:  Production documents cannot be exported.

Transferring learning instances between IQ Bot environments

To move a learning instance from one environment to another, perform the following steps:
1. Ensure that the source and destination systems are running the same IQ Bot version. Learning

instances from different IQ Bot versions cannot be imported because their database schemas will not
match.

2. Back up your database and export the learning instances from the source IQ Bot environment: Backup
and export learning instance on page 1362

3. Import the IQBA file into the destination IQ Bot environment: Импортировать экземпляр для
обучения on page 1363

Backup and export learning instance
Ensure you backup your existing learning instance before exporting it. A learning instance is exported as
IQ Bot archive (IQBA) file. Groups, боты, and learnings associated with the learning instance are also
exported.
When you export a learning instance, only a single document associated with every available бот (Group)
training is exported. However, the production documents do not get exported.

Note:  Ensure that you do not export a learning instance that has only unclassified groups.

1. Log into IQ Bot as an administrator.
2. Щелкните Администрирование > Миграция.
3. Click Create Backup.
4. Select the learning instances you want to back up and then click Backup.
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5. Enter an appropriate name for the IQBA file and click Backup to begin the export process.
The exported data file with the .iqba extension is available in the BackupData folder in your IQ Bot
output directory. For example, C:\Users\Public\Documents\Automation Anywhere IQBot
 Platform\Output\BackupData.

Импортировать экземпляр для обучения
Import a learning instance to use the associated groups and боты in a different Automation 360 IQ Bot
environment.
You can only import a learning instance into a similar or equivalent IQ Bot version. For example, you can
only import an IQ Bot On-Premises (Build 9642) learning instance into an equivalent version of IQ Bot On-
Premises or Cloud.
1. Log into IQ Bot as an administrator.
2. Щелкните Администрирование > Миграция.
3. Click Upload.
4. Select the .iqba file you want to upload from your file system.

Exported learning instances are stored as .iqba files. Ensure you select the correct file to import your
learning instances into your new IQ Bot environment.

5. Select from the following import options:

Import option Результат

Вариант 1. Append imported groups
and trained боты to duplicate existing
learning instances:

Merges new document groups and боты in
existing learning instances.

Note:  When you import the .iqba file
using this option, a trained group in the
imported file overwrites an untrained group
in the destination environment.

Вариант 2. Import learning instances,
and ignore duplicate learning
instances:

Appends only new learning instances, where
the learning instance ID in the .iqba
file differs from the ID in the destination
environment. If a learning instance ID in
the .iqba file is the same as an ID in
the destination environment, the learning
instance from the file is not appended.

Вариант 3. Overwrite duplicate
existing learning instances with
imported learning instances:

All documents groups and боты in the
existing learning instance in the destination
environment are replaced with the ones
from the imported file. This does not impact
the dashboard metrics.

Note:  You must use this option if the
learning instance in the .iqba file was
edited (for example, if fields or table
columns were added).

Вариант 4. Remove all existing
learning instances and replace with
imported learning instances:

Only use this option if it is okay to lose
all the work done so far in an IQ Bot
environment.
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Additional considerations
• If the .iqba file contains a document group that was previously deleted from the learning instance

in the destination environment and you import it using Options 1,3, or 4, IQ Bot restores the
deleted version of that group.

• Document groups in the .iqba file are imported in the same state as they were exported. For
example, if you select Option 3 to overwrite a learning instance with a group in production mode
with an imported learning instance that has a group in staging mode, that imported group remains
in staging mode and incoming documents will not be automatically processed.

For more information on how each option impacts the groups, see Пример. Import options results on
page 1364.

6. Click Open.
After your file is uploaded, click Refresh to manually refresh the page and use the uploaded file from
the list.

7. Click the import icon next to the backup entry in the list.
The imported learning instances are restored in the destination environment.

Пример. Import options results
If the destination IQ Bot environment contains a learning instance with the same ID as the one in the
IQBA file, you must select an import option to instruct IQ Bot how to handle the document groups in the
learning instance. This page walks you through the most-common scenarios.

Scenario 1: Destination environment is empty
In this scenario, the destination environment is empty, such as in the case of a new installation of a testing
environment. For the simplicity of this example, the IQBA file contains one learning instance with two
groups. The fourth column of the table shows the outcome of each import option.
G = group

Import option Environment before
importing IQBA file

Файл IQBA Environment after
importing the IQBA file

Вариант 1. Append
imported groups
and trained боты to
duplicate existing
learning instances:

G1, G2

Вариант 2. Import
learning instances,
and ignore duplicate
learning instances:

G1, G2

Вариант 3.
Overwrite duplicate
existing learning
instances with
imported learning
instances:

G1, G2

G1, G2
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Import option Environment before
importing IQBA file

Файл IQBA Environment after
importing the IQBA file

Вариант 4. Remove
all existing learning
instances and
replace with
imported learning
instances:

G1, G2

Scenario 2: Import a learning instance with new groups
In this scenario, the learning instance in the IQBA file has document groups which are not present in the
learning instance in the destination environment. The fourth column of the table shows the outcome of
each import option, with the groups already present in the environment italicized for emphasis.
Note that in option 3, the imported learning instance (IQBA file) overwrites the duplicate existing learning
instance. To determine whether a learning instance is a duplicate, the system compares the IDs of the
learning instances in the two environments, not the groups. As a result, the environment after the
import only contains G3.

Import option Environment before
importing IQBA file

Файл IQBA Environment after
importing the IQBA file

Вариант 1. Append
imported groups
and trained боты to
duplicate existing
learning instances:

G1, G2, G3

Вариант 2. Import
learning instances,
and ignore duplicate
learning instances:

G1, G2

Вариант 3.
Overwrite duplicate
existing learning
instances with
imported learning
instances:

G3

Вариант 4. Remove
all existing learning
instances and
replace with
imported learning
instances:

G1, G2 G3

G3

Scenario 3: Import a learning instance with duplicate groups
In this scenario, the learning instance in the IQBA file has the same groups as the learning instance in
the destination environment, for example, the groups were retrained. The fourth column of the table
shows the outcome of each import option, with the groups already present in the environment italicized for
emphasis.
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Import option Environment before
importing IQBA file

Файл IQBA Environment after
importing the IQBA file

Вариант 1. Append
imported groups
and trained боты to
duplicate existing
learning instances:

G1, G2, G3

Вариант 2. Import
learning instances,
and ignore duplicate
learning instances:

G1, G2, G3

Вариант 3.
Overwrite duplicate
existing learning
instances with
imported learning
instances:

G3

Вариант 4. Remove
all existing learning
instances and
replace with
imported learning
instances:

G1, G2, G3 G3

G3

Migration Utility enhancements
Starting from the Automation 360 IQ Bot.14 release, enhancements for importing learning instances (that
were created using a custom domain) to the production server are available.
Migrating learning instances (that were created using a custom domain) from one system to another
does not automatically import the associated domain to the target system. Therefore, when you run the
imported learning instances on the production documents, the documents do not get classified because
the associated field names and IDs for the custom domain do not work in the imported learning instance.

Migrating single or multiple learning instances

Prerequisite: The same version of the custom domain must exist in the staging (source) and production
(target) servers.
IQ Bot includes some checks for importing a learning instance to the production environment to ensure
the custom domain associated with a learning instance is migrated to the production server first, so the
learning instances do not fail after migration.
• You can import the same learning instance to the production server multiple times.

However if you import a learning instance with an edited or updated domain and if the updated domain
does not exist in the production server, the system will not allow you to import the learning instance.

• In this scenario, if the Import option is used (IQ Bot > Migration tab) to import the learning
instance, a system-generated error message is displayed stating that the learning instance version is
incompatible, and the import process is canceled.
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• IQ Bot checks for the following when importing a learning instance to the production server:
• Does the domain exist in the production server?
• Do the same fields exist in the production server?
• Do the same field aliases (available variations for a specific field in the documents) exist in the

production server?

• Learning instance import fails if the system detects an issue with any of the checks.
• An import is successful when the user has maintained the same version of the custom domains,

associated with the learning instance, in the staging and production servers.

If the learning instance import fails, the user can find the reason for the migration failure in the following
locations:
• In the IQ Bot Project service log files, which will show an inconsistency in any of the following

parameters:
• domain name
• field names
• project or learning instance name
• field alias names

• In the Control Room > Audit logs

Custom domains in IQ Bot

Migrating RBAC in IQ Bot
When you migrate learning instances that are associated with custom roles, you must also migrate the
roles to enable users in the destination environment to access the learning instances. Before you start your
migration, review the comparison matrix for in RBAC IQ Bot 11.3.5.x with Automation 360 IQ Bot.

Comparing RBAC

The following table compares RBAC provided in IQ Bot 11.3.5.x with Automation 360 IQ Bot:

Функция Supported in IQ Bot 11.3.5.x Supported in Automation 360
IQ Bot

Separation of permissions
to learning instances by
departments using custom roles

Да Да

Assigning roles to learning
instances on creation

Да Да

Support for system roles:
• Automation 360 IQ Bot

administrator
• IQ Bot services
• IQ Bot Validator

Да Да

Changing assigned role for
learning instances

Да Нет
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Функция Supported in IQ Bot 11.3.5.x Supported in Automation 360
IQ Bot

User can have different access
levels to different learning
instances

Да Нет

Transfer of roles when learning
instances are moved from one
environment to another

Нет
However, you can use the
Assign Roles functionality
to assign roles to the learning
instance.

Нет

All permissions of IQ Bot are
implemented

Да Нет
The following permissions are
not implemented:
• Edit learning instance
• Delete learning instance
• Send learning instance to

production
• Импортировать домен

Requirements before migrating RBAC

• Ensure that you do not associate the role of a user who can create a learning instance with any of the
IQ Bot system roles. Instead, associate these users with a custom role.

• If a user who can create a learning instance has a custom role, a correct role corresponding to the
department must be assigned to ensure a seamless RBAC operation on the learning instance. However,
ensure that these users do not have any other role assigned other than the custom role for creating a
learning instance and the corresponding department role.

• User who can create a learning instance must not be associated with any non IQ Bot roles. This
restriction is not applicable to other users with custom roles.

• All users who can create a learning instance must not be assigned to one custom role (for creating
learning instance). Instead, these users must be assigned to department-specific custom role (for
creating learning instance).

• Ensure that the View ALL learning instances permission is not used in the custom role because it
provides users with access to IQ Bot services.

• Ensure that any role other than the department role is not assigned to a learning instance, as this can
increase the risk of unauthorized users accessing the learning instance.

• Users with the Launch validator permission in the custom role can only view IQ Bot if there is at least
one learning instance with documents to validate.

Plan your migration

RBAC functionality such as setup and features for custom roles differ between IQ Bot 11.3.5.x and
Automation 360 IQ Bot. So keep the following in mind for migration:
• You can migrate RBAC to Automation 360 IQ Bot only from IQ Bot 11.3.5 or later versions.
• You can migrate IQ Bot 11.3.5.x to both Automation 360 IQ Bot On-Premises and Cloud.
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• When you migrate RBAC, all the custom and user roles are also migrated from Control Room 11.3.5.x to
Automation 360.

• Ensure you segregate the learning instances for RBAC use cases between departments, organization
units, and so on.

Choose your RBAC migration path

Choose your RBAC migration path based on the IQ Bot version you are currently using and the Automation
360 IQ Bot deployment model that meets your business requirements:
• Migrate RBAC to On-Premises
• Migrate RBAC to Cloud

If you are performing the migration steps using APIs, see IQ Bot roles migration APIs (A-People login
required)

Migrate RBAC to Automation 360 IQ Bot On-Premises
Migrate RBAC from an earlier IQ Bot version (11.3.5.x or later) to Automation 360 IQ Bot On-Premises for
the latest features and enhancements.
1. Create new custom roles (department roles) corresponding to each department or organizational unit

in Control Room.
Consider a scenario where you have setup the RBAC across various departments in your organization
with HR_Dept, Finance_Dept and Sales_Dept as the department roles. For sub-divisions within these
departments, the roles can be Finance_AP_Payments, Finance_Cash_Payments, and so on.

2. Ensure you give the following permissions for each department role that you create:
• View IQ Bot
• View learning Instances
• View learning instances for same role in Control Room

3. Add the respective department roles to all of the IQ Bot users in Control Room.
For example, Sam from the Human Resource department is assigned the HR_Dept role and Susan
from the Finance department is assigned the Finance_Dept role.

4. Associate users who create learning instances with the corresponding roles.
Users creating learning instances for a department can only be associated with IQ Bot roles. For
example, these users cannot be associated with roles such as AA Basic, AA Bot Developer, and so on.
Additionally, only the IQ Bot custom role with Create learning instance permission must be
assigned along with the corresponding department role.

5. Backup the LearningInstanceRoles table in the Automation 360 IQ Bot database.
The database schema name is IQBot.

6. Use the following database query to get the list of learning instances and the roles from the migrated
Automation 360 IQ Bot database:

SELECT p.name as LearningInstance, 
r.projectid as LearningInstanceID, 
r.role as Role FROM [IQBot].[dbo].LearningInstanceRoles r inner join
 [IQBot].[dbo].ProjectDetail p on r.projectid=p.id;

7. Download the output query of the database to a local CSV file.
For example, learninginstanceroles.csv
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8. Remove all the role entries against the learning instances in the local CSV file.
For example, learninginstanceroles.csv. After removing the role entries, duplicate rows for
each learning instance must be removed to keep just 1 row per learning instance in the CSV file.

Note:  If there are learning instances which are not RBAC controlled, then role entries must not be
changed

9. Assign the department role (Step 3) to each of the learning instance in the local CSV file and save
your changes.

10. Remove all the entries from the LearningInstanceRoles table in IQBot database scheme.
You can use the following SQL command to remove the entries:
DELETE from [IQBot].[dbo].LearningInstanceRoles;

11. Insert the modified learning instance role association defined in local CSV file (Step 8) into the
LearningInstanceRoles table.
For example, use the following SQL statement:

INSERT INTO [IQBot].[dbo].LearningInstanceRoles 
(projectid, role) values
 (‘i13454546erty’, ‘HR_Dept’);

12. Verify the RBAC setup in Automation 360 IQ Bot and ensure that only the correct users have the
access to the learning instances.

Migrate RBAC to Automation 360 IQ Bot Cloud
Migrate RBAC from an earlier IQ Bot version (11.3.5.x or later) to Automation 360 IQ Bot Cloud for the
latest features and enhancements.
1. Create new custom roles (department roles) corresponding to each department or organizational unit

in Cloud Control Room.
Consider a scenario where you have setup the RBAC across various departments in your organization
with HR_Dept, Finance_Dept and Sales_Dept as the department roles. For sub-divisions within these
departments, the roles can be Finance_AP_Payments, Finance_Cash_Payments, and so on.

2. Ensure you give the following permissions for each department role that you create:
• View IQ Bot
• View learning Instances
• View learning instances for same role in Control Room

3. Add the respective department roles to all of the IQ Bot users in Control Room.
For example, Sam from the Human Resource department is assigned the HR_Dept role and Susan
from the Finance department is assigned the Finance_Dept role.

4. Associate users who create learning instances with the corresponding roles.
Users creating learning instances for a department can only be associated with IQ Bot roles. For
example, these users cannot be associated with roles such as AA Basic, AA Bot Developer, and so on.
Additionally, only the IQ Bot custom role with Create learning instance permission must be
assigned along with the corresponding department role.

5. Backup the LearningInstanceRoles table in the Automation 360 IQ Bot database.
The database schema name is IQBot.
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6. Use the following database query to get the list of learning instances and the roles from the migrated
Automation 360 IQ Bot database:

SELECT p.name as LearningInstance, 
r.projectid as LearningInstanceID, 
r.role as Role FROM [IQBot].[dbo].LearningInstanceRoles r inner join
 [IQBot].[dbo].ProjectDetail p on r.projectid=p.id;

7. Download the output query of the database to a local CSV file.
For example, learninginstanceroles.csv

8. Remove all the role entries against the learning instances in the local CSV file.
For example, learninginstanceroles.csv. After removing the role entries, duplicate rows for
each learning instance must be removed to keep just 1 row per learning instance in the CSV file.

Note:  If there are learning instances which are not RBAC controlled, then role entries must not be
changed

9. Assign the department role (Step 3) to each of the learning instance in the local CSV file and save
your changes.

10. As the LearningInstanceRoles table in IQBot Cloud will be empty, provide the CSV file (Step 9)
to Automation Anywhere support so that they can update the Cloud database.

11. Insert the modified learning instance role association defined in local CSV file (Step 9) into the
LearningInstanceRoles table.
For example, use the following SQL statement:

INSERT INTO [IQBot].[dbo].LearningInstanceRoles 
(projectid, role) values
 (‘i13454546erty’, ‘HR_Dept’);

Note:  Ensure you perform this step for all the entries in the local CSV file.

12. Verify the RBAC setup in Automation 360 IQ Bot and ensure that only the correct users have the
access to the learning instances.

© 2023 Automation Anywhere. All rights reserved.     1371



    Automation Anywhere - Сборка

Сборка
Automation 360 provides a browser-based, intuitive experience for users to easily automate tasks and
powerful tools for developers to build process automation, delivering security, and governance.

Обзор

Our Рабочая область RPA is a web-based workspace that provides the tools and capabilities to create,
upload, and deploy боты to automate repetitive tasks and processes. It includes the Control Room, Bot
editor, Bot Runner, Bot Creator, and Credential Vault.
Рабочая область RPA предоставляет следующие возможности.
• Automate fast and customize with an actions library for the complicated processes
• Get full visibility and orchestration, from scheduling to automating workloads, with the Control Room
• Assign and manage role-based access with full control and audit trail of every event
• Multi-layered security from cloud to platform to bots ensures granular, privileged access to data.

Сборка боты

Use our Bot editor to create and edit боты on any device and from a web browser. См. раздел Bot editor
for creating боты.
Watch the following videos to get started on building боты:
• Short video on building your first бот:

• Detailed video with a step-by-step guide toward becoming an RPA developer:

For RPA courses, tutorials, certificates and more, visit: Automation Anywhere University: RPA Training and
Certification (A-People login required).
Ссылки, связанные с данной
Действия palette for бот creation
Use actions to build an automation workflow and to instruct a бот what to do. The available actions are
located in the Действия palette of the Bot editor in the Control Room.
Variables overview
Automation 360 offers a variety of variables, each designed to hold specific types of data and is intended
for specific use. Use the topics below to learn more about each variable and how to use them.
Информация, связанная с данной
Automation Anywhere Bot Store
Pathfinder Community A-People
Training - Getting Started with RPA

Bot editor for creating боты
The Bot editor enables users to create and edit боты on any device and from anywhere the user can
access a web browser.
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Обзор

Because Automation 360 is web-based, there is no separate client to download. Access the Bot editor by
logging in to Automation 360, navigating to Automation on the left panel, and then creating or opening a
бот.
The Bot editor is a web-based environment and includes the following features:
• Universal Recorder to simplify capturing processes
• Search for a бот from the public workspace and your private workspace and add that бот to the current

бот.
The location of the selected бот in the public and private workspaces is also displayed.

Прим.:  An error occurs if you add a бот from a folder in the public workspace for which you do not
have the Clone permission for that folder.

• Powerful бот code management
• Python and JavaScript actions support inline scripting without linking, with drag-and-drop integration
• Rich variable passing, with no cross-language mapping required

Bot editor

Use the Bot editor to create and edit any бот through a web browser, regardless of the device or location.
When you create a бот or modify an existing бот, the Bot editor is displayed.
You can create a бот by using the following options:
• On the Home page, click Create a bot.
• On the Automation page, click Create new > Bot in the top-right corner.
•

In the Files and folders table, click Create a bot ( ).

You can modify a бот by using the following options:
• On the Automation page, select the бот to modify, click the actions menu (vertical ellipses) and click

Edit Task Bot.
• Select and open the бот you want modify.

See also the video at the end of this page on how to get started with the Bot editor.
There are three view options for бот creation:

Прим.:  Вы можете использовать окно поиска в представлениях Блок-схема, Список или Схема
и список для поиска текста, переменных или actions в бот. Эта функция может быть полезна при
просмотре или редактировании бот с длинными строками кода.
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• Блок-схема. Displays actions used in an automation as a flow diagram (Default)

Прим.:  The Flow view is not available when you create or edit a бот and the бот exceeds 500 lines of
code. Используйте параметр Показать представление списка для перехода к представлению
списка.

• Список. Displays the actions used in an automation as a list

Прим.:  Перетащите выбранное actions в логику задачи.
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• Схема и список. Displays the actions used in an automation from both Flow and List view aspects

The Flow, List, and Dual views display the following properties of actions:
• The value that you enter for actions such as Set text for all the supported technologies
• Names of the objects on which actions such as Set text, Click, Left click, Get property, and Select

item by index are performed
• Name of the object property mentioned in the action
• Name of the return variable if some value is assigned to a variable
• List of properties for the Get property action

See the video on enhanced бот building experience on Bot editor and AISense for Citizen developers.

Бот Assistant

When you create a бот, use the feature Бот Assistant to get a comprehensive view of line numbers of the
боты that require your action.
The Бот Assistant displays the name of the packages or action and line number on which action is required
by you. When you click the line number, it directly takes you to the line where the error occurs.
For migrated боты, the Бот Assistant displays a comprehensive view of the package or action and line
numbers of the боты that require review or action by you.

More resources

• Free Automation 360 боты and command packages from Bot Store: Automation 360 and AARI pre-built
automation

• Create your first bots

Задачи, связанные с данной
Run a бот
You can run a бот to test an automated process.
Ссылки, связанные с данной
Редактирование бота
Edit бот logic using the Bot editor to add, modify, or delete actions and automation steps.
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Keyboard shortcuts to expand or collapse elements in бот logic
When you are creating a large бот, you can expand or collapse sections using keyboard shortcuts in both
Flow and List views.
By using this feature, you can improve your productivity as a Bot Creator. It enables you to use keyboard
shortcuts in a specific section or all sections, and you can move quickly through the process of developing
a бот.
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Shortcuts to expand or collapse an action is applicable only when the section is selected. You can use the
following list of keyboard shortcuts in your боты.

Shortcut Действие

[ Collapses the current node

Ctrl+[ Collapses all the nodes

] Expands the current node

Ctrl+] Expands all the nodes

← Collapses the current node or collapses to parent
if already collapsed

→ Expands the current node

These keyboard shortcuts to expand and collapse nodes are supported in the following пакеты and
actions:
• Цикл пакет
• Если пакет> If, Else if, and Else actions
• Обработчик ошибок пакет> Try, Catch, and Finally actions
• Шаг пакет
• Trigger Loop пакет> Trigger Loop and Handle actions

Действия palette for бот creation
Use actions to build an automation workflow and to instruct a бот what to do. The available actions are
located in the Действия palette of the Bot editor in the Control Room.

Действия, пакеты, and dependencies

Действия are grouped into пакеты based on the technology they automate. For example, the
Расширенный Excel пакет contains Excel-related actions, such as Open workbook, Go to cell, and
Delete cell, which you can insert in the Bot editor to automate a spreadsheet process.
Each пакет is upgraded and enabled individually to support new functionality. New боты are built with the
default version. Existing боты are not automatically updated. They run using the same пакет version that
they were built with until the Bot Creator manually upgrades to the new version.
When the Control Room deploys a бот, the пакеты used to create the automation are collected and sent
to the Bot Agent on the destination device. The Bot Agent caches the пакеты so that it does not require
updates each time the бот runs.
To shorten the runtime the first time a бот runs on a device, preload the пакеты using the
Preload packages option in the Bot editor. The system loads the пакеты to \ProgramData
\AutomationAnywhere\GlobalCache on the local machine for quick access at runtime.
After an action from a пакет is used in a бот, that пакет becomes a dependent file of that бот.
• Learn more about managing пакеты in Пакеты.
• Developers can learn more about creating packages in SDK для пакетов.
• Learn more about managing боты and пакет dependencies in Бот dependencies.
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Packages and exe files

Пакеты exe process files

DLL Automation.CSharpDLLWrapper.exe

База данных Automation.DatabasePlayer.exe

Working with actions

Важное замечание:  Each action in a пакет provides minimum compatible Control Room and Bot
Agent version information when you create боты. So you can update your боты and reduce runtime errors
caused by an incompatible Control Room or Bot Agent version.

You can configure actions in the Bot editor. Double-click the action to view the fields and features that you
can configure, and double-click or drag an action to insert it into the automation.
Move the mouse over the vertical ellipsis at the top right of an action icon to access the following features:

Копировать action Duplicate the action.
Cut action Copy the action and remove it from the бот code.
Paste after action Paste the copied action below the selected action.

Прим.:  This option only appears when there is an
action in the clipboard.

Удалить action Remove the action from the бот code.
Disable action At run time, бот ignores the action until you enable

it.
Включить точку останова Pauses the бот for debugging purposes.

Debugger tool

Пропустить Use the Step over icon to go to the next action
in debug mode. By default, it starts from the first
action in debug mode.

You can edit multiple actions at a time, using the toolbar at the top of the Bot editor.

Find in this бот (Search box) Search for any text or action such as a пакет name,
actions name, string name, or variable name in the
Flow, List, or Dual view of the TaskBot. You can
search text across multiple pages of the бот and do
not require the pages to be loaded manually. This
feature is useful for viewing or editing a бот with
longer code lines to determine where the searched
text, such as variables, strings, or actions is used
and in which line.
• You can search only within the lines of the code

in the Bot editor.
• The search is not case-sensitive.

© 2023 Automation Anywhere. All rights reserved.     1378



    Automation Anywhere - Сборка

Копировать элементы Copy actions to a clipboard so they can be
duplicated within the бот.

Вырезать элементы Copy the actions and remove them from the бот
code.

Вставить элементы Paste one or more actions after the highlighted
action. If you have not highlighted an action, the
actions are appended to the end of the automation
sequence.

Прим.:  This icon is only enabled when there are
actions in the clipboard.

Копировать в общий буфер обмена Copy actions, triggers, and metadata to a clipboard
that is shared between боты.

Вставить из общего буфера обмена Paste actions, triggers, and metadata from another
бот.

Прим.:  This icon is only enabled when there are
actions in the shared clipboard.

Auto-save functionality of events in Bot editor

В Bot editor при использовании actions для создания автоматизации, когда бот не сохраняется
вручную, выполняется автоматическое сохранение и бот теперь автоматически сохраняет изменения
для определенных событий.

Прим.:  В настоящее время функция автоматического сохранения доступна только для
определенных событий.

Ниже перечислены некоторые события, поддерживающие функцию автоматического сохранения.
• Средство записи При создании бот с определенными actions и щелчке по кнопке Средство

записи событие сохраняется, а когда запись завершена, событие сохраняется автоматически.
• Менеджер переменных. Когда вы создаете или редактируете переменные, чтобы вставить их в

поле action, изменения сохраняются.

Прим.:  Функция автоматического сохранения не поддерживается, когда вы удаляете
переменную или вставляете ее, нажав клавишу F2 для открытия списка переменных.

• Меню действий (вертикальное многоточие): При выборе из этого меню любого action, например
(Пакеты событие сохраняется автоматически. При внесении каких-либо изменений на странице
Пакеты и возврате на страницу Bot editor, событие сохраняется.

• Найти файл. При щелчке по значку Найти файл бот сохраняется, если он не был сохранен
вручную. Кроме того, после щелчка по кнопке Добавить бот сохраняется автоматически.

• Диалоговые окна. При открытии диалогового окна оно автоматически сохраняется, если в него
были внесены какие-либо изменения.

Прим.:  Автоматическое сохранение срабатывает только для диалоговых окон верхнего уровня,
но не для вложенных диалоговых окон.

• Удаление переменных. При удалении неиспользуемых переменных событие сохраняется.
• Изменение названия Бот. При изменении названия бот событие будет сохранено.

© 2023 Automation Anywhere. All rights reserved.     1379



    Automation Anywhere - Сборка

Ресурсы

Ссылки, связанные с данной
Bot editor for creating боты
The Bot editor enables users to create and edit боты on any device and from anywhere the user can
access a web browser.

Advanced search option in Bot editor
When you edit or view a бот, you can use the advanced search feature to find the exact line of action
and the corresponding details where the search text appears, select the search filter criteria, and navigate
through the search results.
Search for any text value or variable name within action details across a бот by using the Advanced
search feature. You can access Advanced search from the Bot editor in one of the following ways:
• Click the Assistant icon at the top.
• Click Search in this bot > Open advanced search icon.
• Use Ctrl + Shift + F shortcut keys.

If you enter a search term in the Search in this bot field and then click the Open advanced search
icon, the search term is carried over and displayed on the Advanced search page.
The Advanced search feature comprises of three components:

Искать

In the Advanced search page, you can enter a search text in the search box. You can search for a text
value, variable name, or long text that has multiple matches.
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Рисунок 2. Искать

You can also select the search filter criteria and navigate through the search results.

Прим.:  Advanced search is not case sensitive.

Search filters

You can use filters to narrow down the search results and quickly locate the search text. The filters can
include the following search criteria:
• Canvas (Flow and List views): to search for any text within the canvas that is displayed in the flow and

list views.
• Text value: to search for any text value within the action details.
• Variable name: to search for any variable name within the action details.

You can select or clear one or all the filter check boxes depending on the search criteria.
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Рисунок 3. Search filter

When you click a matching item from the action details, for example, if you select the second search result
If| Line 6 | 2 matches in the Results tab, you will see the complete line of action that contains the
search text highlighted in the canvas, and the details of the selected action are displayed on the properties
panel. You can see that the searched text botname is appearing in the if condition, as shown in the
properties panel.

Результаты

When you enter the search text and select the filter criteria, the Advanced search page displays the
search results based on action names across the different lines of the бот.
The Results header displays the total count of matched action names and the count of selected action
or line item in a бот. For each action name listed, the line number containing the action and the total
matching results found within the action details are displayed as Action or Trigger | Line number |
Number of matches.

Прим.:  The count displayed in the Results header displays only the count of matching line items (or
actions) within the бот. However, each line item can have multiple matches and is not counted in the
total matching line items. For individual line items, the count of multiple matches is displayed within the
particular line item in the Results tab.

When you select a specific line item against the action name, the action detail page opens within Results
tab displaying a list of all matching results within that action.
When there is more than one search result, you can use the Back button to go to the previous line
and the Next button to go to the next item. When you select the Back or Next button, the action is
highlighted in the canvas, and the detail of the corresponding item is displayed in the properties panel.
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The following example shows how Advanced search works. You are editing a бот with lengthy lines of
code. Now you want to search with the text botname in the Assistant window. The Results header
shows the total count of 10 matched action names and line numbers with the count of matching line items,
such as If| Line 6 | 2 matches.

Рисунок 4. Результаты

AARI Web пакет
The AARI on the web  пакет contains actions that enable Control Room users to configure their боты to
work on requests, tasks, and team members.

Перед началом работы

Убедитесь, что вы выполнили одно из следующих условий, чтобы запустить этот программу пакет:

Условие 1 • Доступ к процессу в назначенной группе.
• Доступ к лицензии пользователя AARI.
• Созданная системой функция

AAE_Robotic_Interface User для
пользователя AARI.

Условие 2 • Доступ к лицензии Bot Runner (с
сопровождением или без сопровождения) или
лицензии Bot Creator.
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• Созданная пользователем роль с
разрешениями Просмотреть моих ботов и
Запустить моих ботов.

Действия in the AARI on the web пакет

The AARI on the web  пакет includes the following actions:

Действие Описание

Назначить задачу Назначает параметры задаче.
• Укажите значение в поле Идентификатор задачи для

присвоения.
• Укажите значение в поле Идентификатор пользователя для

присвоения задачи.
Для идентификатора задачи и пользователя можно выбрать
значение из параметров Переменная или Глобальное
значение. Параметр переменной позволяет добавлять
предопределенные переменные в диапазоне времени (минута, час,
день, месяц, год и т. д.) или использования системы (ЦП и ОЗУ).

• Необязательно. В поле Присвоить результат переменной
присвойте переменную для сохранения в качестве выходного
значения.
Выходные данные сохраняются в виде строкового значения.

Отменить задачу Отменяет задачу.
• Укажите значение в поле Идентификатор задачи для отмены.

Для задания можно выбрать значение из параметров Переменная
или Глобальное значение. Параметр переменной позволяет
добавлять предопределенные переменные в диапазоне времени
(минута, час, день, месяц, год и т. д.) или использования системы
(ЦП и ОЗУ).

• Необязательно. В поле Присвоить результат переменной
присвойте переменную для сохранения в качестве выходного
значения.
Выходные данные сохраняются в виде строкового значения.
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Действие Описание

Создать запрос Создает запрос.
• На палитре Действия дважды щелкните или перетащите действие

Создать запрос из пакета AARI Web.
• В поле Общедоступный процесс найдите и выберите

общедоступный процесс. В поле Входные значения
отображаются исходные поля формы процесса. Эти поля относятся
к поддерживаемым интерактивным элементам формы.

• В поле Входные значения введите значения или переменные для
заполнения исходной формы необходимой информацией.

Прим.:  Для передачи значений с использованием переменных
создайте пользовательскую переменную любого типа: Строка,
Число, Дата и время, Логический, Словарь, Таблица или
Файл. Используйте переменную Словарь для заполнения
информацией поля флажка в исходной форме. Введите
информацию переменной в полях Тип, Подтип, Ключ и
Значение. В поле Подтип выберите Логический. При создании
переменных Словарь соблюдайте соглашение о формате.
Например, рассмотрим атрибуты флажка как «Сан-Хосе»,
«Атланта» и «Сакраменто», и мы хотим выбрать значение
«Атланта» в исходном поле формы. Создайте переменную
Словарь подтипа Логический в следующем формате:
Имя. CheckBoxGroup0

Атрибуты () Ключ Значение

Сан-Хосе CheckBoxGroup0_0 false

Атланта CheckBoxGroup0_1 true

Сакраменто CheckBoxGroup0_2 false

• Необязательно. В поле Присвоить идентификатор запроса
присвойте переменную для сохранения в качестве выходного
значения. Возвращает идентификатор созданного запроса.

• Необязательно. В поле Присвоить ссылку на запрос
присвойте переменную для сохранения в качестве выходного
значения. Это вернет идентификатор созданного запроса.

• Щелкните Сохранить.
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Действие Описание

Получить файл
хранилища

Загрузите файл хранилища на устройство бот.

Важное замечание:  action получения файла хранилища требует
совпадения версий между версией процесса и версией пакет.
Процессы, созданные до Automation 360 v.25, должны использоваться
с версиями пакет до Automation 360 v.25. Аналогичным образом,
процессы, которые созданы после Automation 360 v.25, должны
использоваться с версиями пакет после Automation 360 v.25.

• Укажите URI файла хранилища в поле Переменная.
Введите переменную для ввода файла.

Важное замечание:  Необходимо использовать только параметр
Переменная, а переменной должен быть входной файл,
который заполняется из процесса (Выберите файл в Задача,
выполняемая человеком). Не используйте параметры Файл
Control Room и Файл рабочего стола.

• В поле Полный путь к файлу на локальном устройстве для
сохранения на укажите путь для сохранения файла.
Вы можете сделать выбор из параметров Переменная или
Глобальное значение. Параметр переменной позволяет
добавить определенное пользователем значение, буфер обмена,
строку (ввод, новая строка, отделить и т. д.), систему (имя
задачи, URL-адрес control room и т. д.), предопределенный пакет
переменных (дата, минута, день, время, IP-адрес, операционная
система и т. д.) или табличное аналитическое значение.

• Необязательно В поле Результат выберите переменную.
Выходные данные сохраняются как переменная.
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Действие Описание

Запросы Позволяет пользователю создавать запросы с помощью
пользовательских фильтров.
• Выберите фильтр.

Прим.:  Фильтры для заголовков процессов и запросов, тегов,
идентификаторов, имени группы  и тегов PII имеют одинаковый
список параметров.

• Укажите строковое значение в поле Список или Переменная.
• Укажите свой тип в поле Список или Переменная.
• Список. Введите информацию о значении в полях Тип и

Значение в 0.
• Необязательно. В поле Добавить добавьте дополнительные

значения.
• Переменная. Введите пользовательскую переменную.

• В поле Состояние запроса выберите статус.
Вы можете выбрать ОТКРЫТ, УСПЕХ, ОШИБКА и ОТМЕНЕНО

• Укажите значение в поле Страница.
• Введите значение в поле Начало таблицы при смещении

данных.
• Введите значение в поле Количество рядов на страницу

введите значение.
По умолчанию для количества строк установлено значение 200.

• Укажите параметр в поле Сортировать.
• В поле Направление выберите Нисходящий или

Восходящий.
По умолчанию для направления установлено значение
Нисходящий.

• Выберите параметр в поле Выбрать столбец для
сортировки.
Можно выбрать заголовок процесса или создание запроса,
идентификатор, заголовок, статус или тег PII.

• Выберите Активировать сортировку 2-го уровня и укажите
значения в полях Направление и Выбрать столбец для
сортировки.

• В поле Присвоить результат переменной присвойте
переменную для сохранения в качестве выходного значения.
Выходные данные сохраняются в виде табличного значения.
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Действие Описание

Задачи запросов Позволяет пользователю запрашивать задачи с помощью
пользовательских фильтров.
• Выберите фильтр.

Прим.:  Фильтр для заголовков процессов и запросов, тегов,
идентификаторов, статуса, имя команды и тегов PII предоставляет
тот же список параметров.

• Укажите строковое значение в поле Список или Переменная.
• Укажите свой тип в поле Список или Переменная.
• Список. Введите информацию о значении в полях Тип и

Значение в 0.
• Необязательно. В поле Добавить добавьте дополнительные

значения.
• Переменная. Введите пользовательскую переменную.

• В поле Состояние запроса выберите статус.
Вы можете выбрать ОТКРЫТ, УСПЕХ, ОШИБКА и ОТМЕНЕНО

• Выберите статус в поле Состояние задачи.
Вы можете выбрать варианты В ПРОЦЕССЕ и ВЫПОЛНЕНО.

• Укажите значение в поле Страница.
• Введите значение в поле Начало таблицы при смещении

данных.
• Обновите значение в поле Количество рядов на страницу.

По умолчанию для количества строк установлено значение 200.

• В поле Сортировать  укажите следующие параметры.
• В поле Направление выберите Нисходящий или

Восходящий.
По умолчанию для направления установлено значение
Нисходящий.

• Выберите параметр в поле Выбрать столбец для
сортировки.
Можно выбрать идентификаторы запроса и задачи, заголовки,
создание, статус или теги PII.
Можно выбрать идентификаторы ссылки на запрос и задачи,
заголовки, создание, статус или теги PII.

• Выберите Активировать сортировку 2-го уровня и укажите
значения в полях Направление и Выбрать столбец для
сортировки.

• В поле Присвоить результат переменной присвойте
переменную для сохранения в качестве выходного значения.
Выходные данные сохраняются в виде табличного значения.
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Действие Описание

Участники группы Извлекает список участников группы.
• Укажите значение в поле Идентификатор команды снабжения

для запроса ее пользователей.
Для идентификатора команды снабжения можно выбрать значение
из параметров Переменная или Глобальное значение.
Параметр переменной позволяет добавлять предопределенные
переменные в диапазоне времени (минута, час, день, месяц, год
и т. д.) или использования системы (ЦП и ОЗУ).

• Укажите значение в поле Ссылка на команду снабжения для
запроса ее пользователей.
Для ссылки на команду снабжения можно выбрать значение из
параметров Переменная или Глобальное значение. Благодаря
параметру переменной можно добавлять предопределенные
переменные в диапазоне времени (минута, час, день, месяц, год
и т. д.) или использования системы (ЦП и ОЗУ).

• В поле Присвоить результат переменной присвойте
переменную для сохранения в качестве выходного значения.
Выходные данные сохраняются в виде табличного значения.

Example of using Create a Request action
The Create a Request action from the AARI Web пакет enables you to create a new request in AARI
on the web through a бот. In this example, use the Create a Request action to pass data through бот
variables to initial form of the AARI process.
• You must have a Bot Creator license and be assigned a custom role with the following permissions:

• Check-in and check-out permission
• Create folder permission

• Create a process and check-in the process to the public workspace
• Assign at least one team to the process with the default team selected
• Select the by bot option in the Request creation field

In this example, we will create a process to register new employee details in the company database. The
initial form contains basic information such as Name, ID, Date of Birth, Gender, and Location. We will pass
the initial form data through бот variables.
1. Log in to the Control Room as a Bot Creator user.
2. Create the initial form.

Create an AARI form.
a) On the left plane, click Automation.
b) Click Create new > Form.
c) Enter the form name employee_register_initial_form.
d) Enter the folder location Bots\Employee Registration.

To change where your form is stored, click Choose and follow the prompts.
e) Щелкните Создать и редактировать.
f) Use the following Elements and Element label in the form.
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Элементы Ярлык элемента

TextBox Full Name

Номер ID

Дата Date of Joining

Выпадающее меню Gender

Флажок Location

Select File Resume

• For the Dropdown element, enter Male, Female in the Enter list items separated by
commas field.

• For the Checkbox element, click the plus icon in Checkbox content field and add the
locations San Jose, Tokyo, India.

• For the Select File element, you can limit the file type which can be uploaded by specifying
it in the Enter supported file format separated by commas field. For example; doc, gif,
pdf, png, txt, xls.

g) Щелкните Сохранить.
h) Щелкните Закрыть.

3. Create a new process.
a) In the same folder location, click Create new > Process.

Создание процесса AARI.
b) Enter the process name employee_register.
c) Щелкните Создать и редактировать.
d) Click Start to add an initial form to the process.
e) In the Select initial data form field, browse and select the initial form,

employee_register_initial_form.
f) Select AARI Storage in the File upload storage dropdown.
g) Provide Request title as Employee Registration.
h) Щелкните Сохранить.
i) Щелкните Закрыть.
j) Check in this process to the public workspace.

4. Create a new бот.
a) In the same folder location, click Create new > Bot.
b) Enter the бот name employee_register_request_bot.
c) Щелкните Создать и редактировать.
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5. Create the following variables:
• emp_name: String type; use as input.
• emp_id: Number type; use as input.
• emp_date_of_joining: Datetime type; use as input.
• emp_gender: String type; use as input.
• emp_location: Dictionary type, Boolean subtype; use as input. From the check box attributes given

above, if you want to select the value San Jose for the location attribute in the initial form field,
click the plus and create the dictionary variable in the format as given below:
Name: emp_location

Атрибуты () Ключ Значение

Сан-Хосе CheckBoxGroup0_0 True

Tokyo CheckBoxGroup0_1 False

Индия CheckBoxGroup0_2 False

• emp_resume: File type; use as input, select Desktop folder or file for the Default value and
browse and select the file you want to upload.

• employee_registration_request_id: Number type; use as output.

6. Use the Create a Request action from AARI Web пакет.
a) На палитре Действия дважды щелкните или перетащите действие Создать запрос из

пакета AARI Web.
b) In the Public Process field, browse and select the public process employee_register. В поле

Входные значения отображаются исходные поля формы процесса. Эти поля относятся к
поддерживаемым интерактивным элементам формы.

c) In the Input values field, enter the values or variables to complete the required information to
the initial form as given below:
• emp_name: $emp_name$
• emp_id: $emp_id$
• emp_date_of_joining: $emp_date_of_joining$
• emp_gender: $emp_genders$
• emp_location: $emp_location$. To select the location San Jose in the initial form field, add

the key and value pair for the attributes as given below:

Атрибуты () Ключ Значение

Сан-Хосе CheckBoxGroup0_0 True

Tokyo CheckBoxGroup0_1 False

Индия CheckBoxGroup0_2 False

• emp_resume: $emp_resume$
• employee_registration_request_id: $employee_registration_request_id$

d) Щелкните Сохранить.
e) Щелкните Закрыть.
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7. Deploy the бот.
a) Click Run.
b) In the Set input variables field, enter the values for the input variable.
c) Щелкните Подтвердить.

The бот deploys successfully and a new request is created through the default team assigned to the
process. The initial form fields are filled with the input provided through the бот. In the web interface,
an AARI admin can verify that a new request is created, and the data has been selected properly.

Active Directory пакет
Use the Active Directory пакет to automate actions in the Active Directory. An Active Directory is
a directory service provided by Microsoft to assist the admin in managing users across a group or
organization.
Рабочая область RPA uses Lightweight Directory Access Protocol (LDAP) to read from and edit users in
the Active Directory. The server and domain names are combined to create an LDAP path, which is used to
connect to the Active Directory.

Перед началом работы

Выполните указанные ниже actions в рамках Active Directory пакет из числа доступных actions.
1. Establish a connection with the Active Directory using the Connect action. Используйте это же имя

сеанса для других actions. Using Connect action for Active Directory

2. Используйте actions для автоматизации задачи.
3. After you have automated all the Active Directory-related tasks, terminate the connection to the server

using the Disconnect action.

Operations in the Active Directory пакет

The Active Directory пакет includes the following operations:

Операция Описание

Computer operations См. раздел Computer operations.

Group operations См. раздел Group operations.

LDAP: операции См. раздел LDAP: операции.

Organizational unit
operations

См. раздел Organizational unit operations.

User account
operations

См. раздел User account operations.

Computer operations
The computer operations in the Active Directory пакет contain various actions to automate tasks related to
computers, including create, delete, get property, rename, and set property.
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Действия в Active Directory пакет

The Active Directory пакет includes the following actions for computer operations:

Действие Описание

Создать компьютер См. Create computer action in Active Directory

Удалить компьютер См. Delete computer action in Active Directory

Получить свойство
компьютера

См. Get computer property action in Active Directory

Переместить
компьютер

См. Using the Move computer action

Переименовать
компьютер

См. Rename computer action in Active Directory

Установить свойство
компьютера

См. Set computer property action in Active Directory

Create computer action in Active Directory
The Create computer action in the Active Directory пакет enables you to create a new object for the
computer.

Настройки

• Enter the same session name as the one you used in the Connect action.
• Enter a name for the computer.
• Необязательно. Enter a description of the computer.

Delete computer action in Active Directory
The Delete computer action in the Active Directory пакет enables you to delete an existing computer.

Настройки

• .Enter the same session name as the one you used in the Connect .
• Enter a name for the computer.

Get computer property action in Active Directory
The Get computer action in the Active Directory пакет enables you to retrieve a specific property value
for a computer.

Настройки

• Enter the same session name as the one you used in the Connect .
• Enter the computer name.
• Enter the property.
• Assign the value to a string variable.
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Using the Move computer action
Use the Move computer action to move the computer from an existing location to a new location.
Ensure there is an existing computer.
Computer operations

1. In the Действия palette, double-click or drag the Move computer action from the Active
Directory пакет.

2. Add the computer name:
• Select the name from the server:

a. Click Add computer from server.
b. Enter the host and domain credentials in the Connect to server window and click Connect.
c. In the Select computer window, select the computer name from the Domain Objects panel

and click Apply.

• Enter the name in the Computer name field.

3. Add the LDAP path: or perform the following steps if you choose the option :
• Enter the path in the Move to field.
• Click Select computer object and perform these steps:

a. Enter the host and domain credentials in the Connect to server window and click Connect.
b. In the Select computer window, select the destination server path from the Domain

Objects panel and click Apply.

4. Enter the same session name in the Active Directory session that you used in the Connect action.
5. Click Save and Apply.

Rename computer action in Active Directory
The Rename computer action in the Active Directory пакет enables you to rename an existing computer.

Настройки

• Enter the same session name as the one you used in the Connect .
• Enter a name for the computer.
• Enter a new name for the computer.

Set computer property action in Active Directory
The Set computer property action in the Active Directory пакет enables you to assign a value to a
computer property.

Настройки

• Enter the same session name as the one you used in the Connect .
• Enter the computer name.
• Enter the property to update.
• Enter the new value.
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Group operations
The group operations in the Active Directory пакет contain various actions to automate tasks related to
groups, including create, delete, get property, and set property.

Действия в Active Directory пакет

The Active Directory пакет includes the following actions for group operations:

Действие Описание

Создать группу См. Create group action in Active Directory

Удалить группу См. Delete group action in Active Directory

Получить свойство
группы

См. Get group property action in Active Directory

Переименовать
группу

См. Rename group action in Active Directory

Установить свойство
группы

См. Set group property action in Active Directory

Create group action in Active Directory
The Create group action in the Active Directory пакет enables you to create a new group.

Настройки

• Enter the same session name as the one you used in the Connect .
• Enter a unique name for the group.
• Необязательно. Enter a description for the group.
• Select the group scope from the following options:

• Domain Local
• Global
• Universal

Group scope
• Select the group type from the following options:

• Security: Provides users with access rights to folders.
• Distribution: Sends emails to a group of users.

Delete group action in Active Directory
The Delete group action in the Active Directory пакет enables you to delete an existing group.

Настройки

• Enter the same session name as the one you used in the Connect .
• Enter the name of the group to delete.
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Get group property action in Active Directory
The Get group property action in the Active Directory пакет enables you to retrieve a specific property
value for the group.

Настройки

• Enter the same session name as the one you used in the Connect .
• Enter the group name.
• Enter the property.
• Assign the value to a string variable.

Rename group action in Active Directory
The Rename group action in the Active Directory пакет enables you to rename an existing group.

Настройки

• Enter the same session name as the one you used in the Connect .
• Enter the group name.
• Enter a new name for the group.

Set group property action in Active Directory
The Set group property action in the Active Directory пакет enables you to assign a value to a group
property.

Настройки

Assigns a value to a group property.
• Enter the same session name as the one you used in the Connect .
• Enter the group name.
• Enter the property to update.
• Enter the new value.

LDAP: операции
The Lightweight Directory Access Protocol (LDAP) operations in the Active Directory пакет contain various
actions to automate tasks related to LDAP, including connect, disconnect, and run query.

Действия в Active Directory пакет

The Active Directory пакет includes the following actions for LDAP operations:

Действие Описание

Подключить См. Using Connect action for Active Directory

Отключить Closes the connection with the LDAP server.

Выполнить запрос См. Run query action in Active Directory
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Using Connect action for Active Directory
Use the Connect action to establish a connection with an Active Directory server. This is the first action
you must use to automate an Active Directory related task.
This action enables you to provide the server credentials and details, and associate this information with
a session name. Use this same session name for the other Active Directory actions so that you have to
provide the server information only once.
To establish a connection with an Active Directory server, follow these steps:
1. На палитре Действия дважды щелкните или перетащите action Подключить из пакет Active

Directory.
2. Введите имя сеанса.
3. Enter or create the LDAP URL:

• Parent path: Enter the LDAP URL that identifies the server that hosts the Active Directory
services.
For example, LDAP://192.168.2.60/DC=corporate,DC=com

• Build parent path: Create the LDAP URL:
a. Click the Build parent path option to connect to the Active Directory server.
b. In the Connect to server window, enter the host and domain credentials, and click

Connect.
c. In the Object Explorer window, select the specific path from the Objects panel.
d. Verify the selected LDAP URL path in the Preview field and click Apply.

4. In the Login user field, provide your username with one of the following options:
• Учетные данные. Select a credential from the Credential Vault. Credentials and credential

variables in the Bot editor
• Переменная. Select a variable holding a credential data type value. Your variables (user-defined)
• Insecure string: Enter a value or select a variable.

Важное замечание:  Values entered using this option are not encrypted.

5. In the Login password field, provide your password with one of the following options:
• Учетные данные. Select a credential from the Credential Vault. Credentials and credential

variables in the Bot editor
• Переменная. Select a variable holding a credential data type value. Your variables (user-defined)
• Insecure string: Enter a value or select a variable.

Важное замечание:  Values entered using this option are not encrypted.

6. Щелкните Сохранить.
7. After you have automated all the Active Directory-related tasks, terminate the connection to the server

using the Disconnect action.

Run query action in Active Directory
The Run query action in the Active Directory пакет enables you to run a specified Active Directory query.
The query results are stored in a list variable, either for object names or LDAP paths, depending on the
option selected.
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Настройки

• Enter the same session name as the one you used in the Connect .
• Input the query. Пример. (&(objectCategory=person)(objectClass=user)(name=A*))
• Specify the return type. Select either the Object Name or LDAP Path option.
• Assign the value to a string variable.

Organizational unit operations
The organizational unit operations in the Active Directory пакет contain various actions to automate tasks
related to organizational units, including create, delete, and rename organizational units, and get and set
property.

Действия в Active Directory пакет

The Active Directory пакет includes the following actions for organizational unit operations:

Действие Описание

Создать
подразделение

См. Create organizational unit action in Active Directory

Удалить
подразделение

См. Delete organizational unit action in Active Directory

Получить свойство
подразделения

См. Get organizational unit property action in Active Directory

Переместить
подразделение

См. Using the Move organizational unit action

Переименовать
подразделение

См. Rename organizational unit action in Active Directory

Установить свойство
подразделения

См. Set organizational unit property action in Active Directory

Create organizational unit action in Active Directory
The Create organizational unit action in the Active Directory пакет enables you to create a new object
for the organizational unit.

Настройки

• Enter the same session name as the one you used in the Connect .
• Enter a name for the organizational unit.
• Необязательно. Enter a description of the organizational unit.

Delete organizational unit action in Active Directory
The Delete organizational unit action in the Active Directory пакет enables you to delete an existing
organizational unit.

© 2023 Automation Anywhere. All rights reserved.     1398



    Automation Anywhere - Сборка

Настройки

• Enter the same session name as the one you used in the Connect .
• Enter the name of the organizational unit to delete.

Get organizational unit property action in Active Directory
The Get organizational unit property action in the Active Directory пакет enables you to retrieve a
specific property value for an organization and assigns the results to a variable.

Настройки

• Enter the same session name as the one you used in the Connect .
• Enter the organizational unit name.
• Enter the property.
• Assign the retrieved value to a string variable.

Using the Move organizational unit action
Use the Move organizational unit action to move an organizational unit from an existing location to a new
location.
Ensure there is an existing organizational unit.
Organizational unit operations

1. In the Действия palette, double-click or drag the Move organizational unit action from the
Active Directory пакет.

2. Add the organizational unit name:
• Add the name from the server by performing these steps:

a. Click Add organizational units from server.
b. Enter the host and domain credentials in the Connect to server window and click Connect.
c. In the Select organizational unit window, select the organizational unit name from the

Domain Objects panel and click Apply.

• Enter the name in the Organizational unit name field.

3. Add the LDAP path: or perform the following steps if you choose the option Select organizational
unit object
• Enter the path in the Move to field.
• Select organizational unit object and perform these steps:

a. Enter the host and domain credentials in the Connect to server window and click Connect.
b. In the Select organizational unit window, select the destination server path from the

Domain Objects panel and click Apply.

4. Enter the same session name in the Active Directory session that you used in the Connect action.
5. Click Save and Apply.

Rename organizational unit action in Active Directory
The Rename organizational unit action in the Active Directory пакет enables you to rename an existing
organizational unit.
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Настройки

• Enter the same session name as the one you used in the Connect .
• Enter the name of the organizational unit to rename.
• Enter the new name.

Set organizational unit property action in Active Directory
The Set organizational unit property action in the Active Directory пакет enables you to assign a value
to an organizational property.

Настройки

• Enter the same session name as the one you used in the Connect .
• Enter the organizational unit name.
• Enter the property to update.
• Enter the new value.

User account operations
The Active Directory пакет contains various actions to automate tasks related to user account
management, including create, delete, get property, remove, rename, and set property.

Действия в Active Directory пакет

The Active Directory пакет includes the following actions for user account operations:

Прим.:  We now support Active Directory user operations by logon name with domain and can provide the
domain name to extract the user details. When you retrieve user property or perform any user operation
based on the logon name (userPrincipalName), and if the user domain name differs from the domain
specified in the LDAP path, the user properties are now successfully retrieved regardless of whether it
contains a domain name or not.
For example, LDAP Path: LDAP://ADServer/DC=automation, DC=net

User Logon name

userPrincipalName: kim@aaengg.net User can provide logon name as
kim@aaengg.net.

userPrincipalName: shaun@aasales.net User can provide logon name as
shaun@aasales.net.

userPrincipalName:sarah@automation.net user can provide a logon name as either sarah
or sarah@automation.net.

When you perform any user action on the logon name, and if the logon name has a duplicate user under
subDomain and subDomain@rootDomain, the user property is retrieved for the user with the root domain.
For example, LDAP Path: LDAP://ADServer/DC=automation, DC=net
• User 1: userPrincipalName (logon name) is kim@aaengg.net.
• User 2: userPrincipalName (logon name) is kim@aaengg.net@automation.net.
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If you enter the logon name as kim@aaengg.net or kim@aaengg.net@automation.net, the
operations will be performed on the second user that is kim@aaengg.net@automation.net.

Действие Описание

Добавить
пользователей в
группу

См. раздел Using the Add users to group action.

Создать пользователя См. раздел Using the Create user action.

Change user password See Change user password action in Active Directory

Удалить
пользователя

См. Delete user action in Active Directory

Отключить учётную
запись пользователя

См. Disable user account action in Active Directory

Включить учётную
запись пользователя

См. Enable user account action in Active Directory

Получить всех
пользователей
группы

См. Get all users of a group action in Active Directory

Получить свойство
пользователя

См. Get user property action in Active Directory

Удалить
пользователей из
группы

См. раздел Using the Remove users from group action.

Переименовать
пользователя

См. Rename user action in Active Directory

Установить свойство
пользователя

См. Set user property action in Active Directory

Update account
options

See Update account options action in Active Directory

Обновить сведения о
пользователе

См. Using the Update user details action

Using the Add users to group action
Use the Add user to group action to add an existing user to a user-created group.
Ensure there is an existing user and group.
User account operations | Group operations

1. In the Действия palette, double-click or drag the Add users to group action from the Active
Directory пакет.
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2. From the Select user field, select one of the following options:
• Add user manually: Enter the Name and Ldap path of the user in the Add user window and

click Add.
• Add users from server: Add an existing user from the server:

a. Enter the host and domain credentials in the Connect to server window and click Connect.
b. In the Select user window, select the user from the Objects panel and click Add user.

The user name and LDAP path of the user is added in the Select user table.

3. Add the user to the specified group by choosing one of the following options:
• Group name: Enter the group name to add the existing user to a specific group.
• Select user group: Add an existing user to a group:

a. Enter the host and domain credentials in the Connect to server window and click Connect.
b. In the Select user window, select the group from the Objects panel to add user to the

destination group and click Apply.

4. Enter the same session name in the Active Directory session that you used in the Connect action.
5. Click Save and Apply.

Using the Create user action
Use the Create user action to configure and activate a new user.
Connect to the Active Directory server.
Using Connect action for Active Directory

1. In the Действия palette, double-click or drag the Create user action from the Active Directory
пакет.

2. In the Session name field, enter the session name that you provided in the Connect action.
3. Введите имя пользователя.

For example, John Smith.
4. Enter the logon name.

The user will use this value to log in to the account.
For example, john.smith.

5. Enter the user's first name.
6. Необязательно: Enter these user details: last name, display name, initials, email address, description,

department, and title.
7. Select Active user to activate the user.
8. Select the Password settings check box to set the password for the user.
9. Enter the password.

You can select Credential to use a value from the Credential Vault, Variable to use a credential
variable, or Insecure string to manually enter a password.

10. Select the option that enables the user to either change or not change their password at the next
login.
If you choose the Don’t require password change at next login option, you have additional
options to select.
• User can’t change password
• Password doesn’t expire
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11. Щелкните Сохранить.

Change user password action in Active Directory
The Change user password action in the Active Directory пакет enables you to change the user
password.

Настройки

• Enter the user name. You can select Credential to use a value available in the Credential Vault,
Variable to use a credential variable, or Insecure string to manually enter a user name.

• Enter the new password. You can select Credential to use a value available in the Credential Vault,
Variable to use a credential variable, or Insecure string to manually enter a password.

• Enter the same session name in the Active Directory session that you used in the Connect action.

Delete user action in Active Directory
The Delete user action in the Active Directory пакет enables you to delete an existing user.

Настройки

• Enter the same session name as the one you used in the Connect .
• Select whether to search for the user by User name or Logon name.

Прим.:  Before removing a user, make certain all unfinished development of bots are checked-in.

Disable user account action in Active Directory
The Disable user account action in the Active Directory пакет enables you to disable a user account.

Настройки

• Enter the same session name as the one you used in the Connect .
• Select whether to search for the user by User name or Logon name.

Enable user account action in Active Directory
The Enable user account action in Active Directory пакет allows you to enable a user account.

Настройки

• Enter the same session name as the one you used in the Connect .
• Select whether to search for the user by User name or Logon name.

Get all users of a group action in Active Directory
The Get all users of a group action in Active Directory пакет enables you to retrieve a list of all the
users of a group, and assigns the results to a variable.

Настройки

• Enter the same session name as the one you used in the Connect .
• Enter the group name.
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• Specify the return type. Select either the Object Name or LDAP Path option.
• Assign the value to a string variable.

Get user property action in Active Directory
The Get user property action in the Active Directory пакет enables you to retrieve a specific property
value for a user and assigns the results to a variable.

Настройки

• Enter the same session name as the one you used in the Connect .
• Select whether to search for the user by User name or Logon name.
• Enter the property.
• Assign value to a string variable.

Using the Remove users from group action
Use the Remove users from group action to remove a user from a group.
Ensure there is an existing user assigned to a group.
Using the Add users to group action

1. In the Действия palette, double-click or drag the Remove users from group action from the
Active Directory пакет.

2. From the Select user field, select one of the following options:
• Add user manually: Enter the Name and Ldap path of the user in the Add user window and

click Add.
• Add users from server: Add an existing user from the server:

a. Enter the host and domain credentials in the Connect to server window and click Connect.
b. In the Select user window, select the user from the Objects panel and click Add user.

The user name and LDAP path of the user is added in the Select user table.

3. To remove the user from a group, select one of the following options:
• Group name: Enter the group name to remove the existing user from a group.
• Select user group: Remove an existing user from a group.

a. Enter the host and domain credentials in the Connect to server window and click Connect.
b. In the Select user window, select the group from the Objects panel to remove user from the

group and click Apply.

4. Enter the same session name in the Active Directory session as you used in the Connect action.
5. Click Save and Apply

Rename user action in Active Directory
The Rename user action in Active Directory пакет enables you to rename the user logon name or the
user account name.

Настройки

• Enter the same session name as the one you used in the Connect .
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• Select whether to search for the user by User name or Logon name.
• Enter the name to search for.
• In the New name field, enter the updated name.
• Select from the following options to specify what to update:

• Rename user name
• Rename logon name
• Rename user and logon name

Set user property action in Active Directory
The Set user property action in Active Directory пакет enables you to assign a value to a user property,
view the current details, and update it.

Настройки

• Enter the same session name as the one you used in the Connect .
• Select whether to search for the user by User name or Logon name.
• Enter the property to update.
• Enter the new value.

Update account options action in Active Directory
The Update account options action in Active Directory пакет enables you to set account attributes for
the user.

Настройки

• Specify the user name. You can select Credential to use a value from the Credential Vault, Variable
to use a credential variable, or Insecure string to manually enter a user name.

• Select the status of the user as Active or Inactive.
• Select an option indicating whether the user can change their password at the next login or not.

If you choose the Don’t require password change at next login option, you have additional
options to select.
• User can’t change password
• Password doesn’t expire

• Enter the same session name in the Active Directory session that you used in the Connect action.

Using the Update user details action
Use this action to update the details of a user.
Connect to the Active Directory server.
Using Connect action for Active Directory

1. In the Действия palette, double-click or drag the Update user details action from the Active
Directory пакет.

2. In the Session name field, enter the session name that you provided in the Connect action.
3. Select whether to search for the user by User name or Logon name.
4. Enter the user's first name.
5. Необязательно: Enter the following user details: last name, display name, initials, email address,

description, department, and title.
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6. Щелкните Сохранить.

Analyze пакет
Use the actions in the Analyze пакет to specify the actions and variables to use in the Bot Insight
dashboard and widgets. The Analyze пакет enables you to perform transactional analytics for the data
that is logged by the variables when the бот runs.

Прим.:  The proxy configuration with authentication is currently not supported.

Действия in the Analyze пакет

The Analyze пакет includes the following actions:

Действие Описание

Закрыть Closes a transaction.
• In the Transaction name field, enter the transaction name that you

provided in the Open action.
• In Dictionary variable, select the following options:

• All user-defined variables: Include all the user-defined string,
numeric, and datetime variables from the бот to populate the Bot
Insight dashboards.

• Manually select the variables to include in the Bot Insight
dashboards.

Открыть Opens a transaction. Insert the actions that you want to include for
analysis between the Open and Close actions. In the Transaction name
field, enter a transaction name.

Using the Open and Close actions with the Loop пакет
• If you want to capture all the data within the loop in the Bot Insight dashboard, use the Open and

Close actions inside the loop.
Пример. If you are using the For each row in CSV/TXT iterator in the Loop action to read values
from each row in a Microsoft Excel sheet, use the Open and Close actions inside this loop to analyze
and capture the data of each row in the Bot Insight dashboard.

• If you want to capture only the last interpreted data of the loop in the Bot Insight dashboard, use the
Open and Close actions outside the loop.
Пример. If you are using the For each row in CSV/TXT iterator in the Loop action to read values
from each row in a Microsoft Excel sheet, use the Open and Close actions outside this loop to capture
only the data in the last row of the Excel sheet in the Bot Insight dashboard.

Using the Open and Close actions with the Error handler and If пакеты
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• If you want to analyze and capture error messages during бот execution in the Bot Insight dashboard,
use the Open and Close actions with an Error handler пакет.
Пример.
1. Create a бот with multiple If actions within a loop.
2. To capture errors, within every If action, add an Error Handler > Catch action.
3. Inside the loop, after every If action, add the Analyze > Close action to capture the errors inside

every If condition on the Bot Insight dashboard for analysis.

Example task:  See the following topic for an example of building a бот to retrieve data from a website
to create visualizations in Bot Insight: Build a Bot Insight dashboard бот. The example includes using the
Open and Close actions inside a loop when using the For each row in CSV/TXT iterator in the Loop
action.

Apigee action пакет
Use the Apigee package to connect to an Apigee instance to run integrations and collaborate efficiently to
function as one unit.
Apigee Integration offers business organizations of all sizes the tools needed to connect and manage
the multitude of software applications required to support business operations in a digital world. With
Apigee Integration's out-of-the-box triggers, configurable tasks, and friendly user interface, you can create
enterprise-level integrations with ease. All the Automation 360 actions can configured to an API trigger to
invoke executions for Apigee integrations.

Apigee Connect
You can connect to a Google Cloud Platform (GCP) instance using the Apigee Connect action. The GCP
manages access to your Apigee instance.
• Create a GCP account (GCP Cloud) and create a GCloud project.
• Login to your GCloud account at Google Cloud Project and create a project. If you already have access

to a project, you will see your project here.
• Create an OAuth 2.0 Client ID. A client ID is used to identify a single application to Google's OAuth

Servers. For more details, see Apigee Connect.

You can connect to an Apigee instance using the Apigee Connect action from Automation 360.
1. Open the Google Cloud console.
2. At the top-left, click Menu > APIs & Services > Credentials.
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3. Click on an application under OAuth 2.0 Client IDs that you want to connect.

4. Copy the values from Client ID, Client secret, and URI fields.
5. Create a new бот. For more details, see Создание первого бот.
6. From the Actions pane, select Apigee > Connect and place it under the Start of the бот flow.
7. To connect using User Account, complete the following steps:

a) In the User Email Address field, enter the email address used to login to the GCloud account.
b) In the Client ID field, paste the Client ID copied from the GCloud. This example uses Insecure

string whereas you can use Credential or Variable options for better security.
c) In the Client Secret field, paste the Client Secret copied from the GCloud.
d) In the Redirect URI field, enter the redirect URI from the GCloud account.
e) Enter Default as the session name.

Прим.:  You can use one of the following options to specify the User Email Address/Client
ID/Client secret/ Redirect URI:
• Учетные данные. Enables you to use a value in the Credential Vault that contains information

about the User Email Address/Client ID/Client secret/Redirect URI.
• Переменная. Enables you to use a credential variable that contains information about the User

Email Address/Client ID/Client secret/Redirect URI..
• Insecure string: Enables you to enter the User Email Address/Client ID/Client secret/Redirect

URI. User Email Address/Client ID/Client secret/Redirect URI
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Apigee Execute Integration
You can configure and execute an integration in Apigee using the Apigee Execute Integration action.
• Create a GCP account (GCP Cloud) and create a GCloud project.
• Login to your GCloud account at Google Cloud Project and create a project. If you already have access

to a project, you will see your project here.
• Create an OAuth 2.0 Client ID. A client ID is used to identify a single application to Google's OAuth

Servers. For more details, see Apigee Connect.

Use the Apigee Execute action to execute an integration in an Apigee instance from Automation 360.
1. Open the Google Cloud console.
2. At the top-left corner, click Menu > APIs & Services > Credentials.
3. Select the application under OAuth 2.0 client IDs that you want to connect.

4. Copy the values from Client ID, Client secret, and URI fields.
5. Войдите в Control Room.
6. Create a new бот. For more details, See Создание первого бот.
7. From the Actions pane, select Apigee > Execute integration and place it under the Start of the

бот flow.
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8. Click Discover integrations to configure. Step 1/4: Connect to Apigee X appears. Enter the
following:
a) In the User Email Address field, provide the email address that is used to log in to the GCloud

account.
b) In the Client ID field, paste the Client ID copied from GCloud. In this illustration, Insecure

string is used, while you can use Credential or Variable options for better security.
c) In the Client Secret field, paste the Client Secret copied from GCloud.
d) In the Redirect URI URL, provide a redirect URI from the GCloud account.

Прим.:  You can use one of the following options to specify the User Email Address/Client
ID/Client secret/ Redirect URI:
• Учетные данные. Enables you to use a value in the Credential Vault that contains information

about the User Email Address/Client ID/Client secret/Redirect URI.
• Переменная. Enables you to use a credential variable that contains information about the User

Email Address/Client ID/Client secret/Redirect URI..
• Insecure string: Enables you to enter the User Email Address/Client ID/Client secret/Redirect

URI. User Email Address/Client ID/Client secret/Redirect URI

9. Щелкните Подключить.
If the credentials are correct, it gets connected to GCloud and the Step 2/4: Load Integration
screen appears.

10. Select the following in the Step 2/4: Load Integration screen.
a) Click the Project ID drop-down and select the project ID from where you want to load the

integration.
b) Click the Location drop-down and select the location from where you want to load the

integration.

11. Щелкните Вперед.
Step 3/4: Select an Integration screen appears with all the available integrations.

12. Select an integration from the list.
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13. Щелкните Вперед.
Step 4/4: Configure my Integration screen appears with all the configuration options.

14. In the Step 4/4: Configure my Integration screen, click the API Trigger drop-down and select
the trigger you want to invoke.

The input parameters are the parameters retrieved from Apigee.
15. Щелкните Выполнено.

All the selected options are displayed as parameters in the Apigee: Execute integration action.
16. Click Add new input parameter to manually add the input parameters. You can provide the

parameter value for different parameter types as specified in the following table:

Тип параметра Значение параметра Пример

Строка Specify a string value
stored as a variable.

$str_INString$

Целое число Specify a number. 9

Двойное Specify a decimal number. 20,5

JSON Specify a JSON string. $str_JSONString$

String Array Specify string values in an
array.

[a,b,c]

Integer Array Specify integers in an
array.

[11,22,334]

Double Array Specify integers and
decimal numbers in an
array.

[23.5,27,44.5]

Логический Specify boolean value as
True or False.

True

Boolean Array Specify boolean values as
an array.

[true,false]

- - (Manual entry) Specify any value from the
above formats.

17. Enter Default as the session name.
18. To verify the response from the Apigee integration, you can store the response to a variable. Пример.

Execution.

Интеграция приложений пакет
Extract text from a window and save it to a string variable by using the actions in the Интеграция
приложений пакет.
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The Интеграция приложений пакет supports the following technologies:
• UNIX shells, such as Cygwin, PowerShell, and GIT shell
• Windows applications, such as Calculator, Command Prompt, and Notepad
• Java applications that are based on the Standard Widget Toolkit and Abstract Window Toolkit, which

can draw text using Windows text-drawing APIs

The actions in the Интеграция приложений пакет are based on legacy technology and have certain
limitations on specific applications. To seamlessly obtain data from applications and browsers, use the
Пакет Средство записи.

Building боты with actions from the Интеграция приложений пакет

1. Open the application or file from which you want to capture the text using the Application > Open
program/file action.

Приложение пакет
2. Extract the text using one of the actions from the Интеграция приложений пакет.
3. Use any of the following actions from the Строка пакет to manipulate the captured text:

• Extract text: Extracts text from the source string using logical operators.
• Split: Splits the string into multiple strings and stores the output in a list variable.
• Trim: Trims blanks and white spaces from a string.

Строка пакет

Действия в Интеграция приложений пакет

пакет Интеграция приложений включает в себя указанные ниже actions.

Действие Описание

Capture area См. раздел Capture area action.

Capture scrollable
text

См. раздел Capture scrollable text action.

Capture text of
window

См. раздел Capture text of window action.

Ссылки, связанные с данной
Screen resolution dependent пакеты
The screen resolution between the Bot Runner and Bot Creator device should be consistent as when
resolution-dependent пакеты are used to build боты, any screen resolution difference between the Bot
Creator and Bot Runner device will impact the боты during runtime.

Capture area action
The Capture area action enables you to extract text from within the captured area of a window and saves
it to a string variable.
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Настройки

Extracts text from within the captured area of a window and saves it to a string variable.
• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.

• Приложение. Выберите из списка окон, включая окна браузера, которые в настоящее время
открыты на устройстве .

• Браузер. Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based , and  browsers.

• Переменная. Выберите существующую переменную окна, чтобы задать заголовок в
заголовке окна приложения.

• Insert a wildcard character (*) in the Window title field to search for window titles that can change.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

• Необязательно. Select the Resize window option to specify the window dimensions.
This option delivers a more reliable бот. It resizes the window to the dimensions at which the task was
recorded, which enhances the bot's ability to identify the target object.

• Click Capture region and select the area to capture.
• In the Save captured text to a variable field, select a string variable.

Capture scrollable text action
The Capture scrollable text action enables you to capture scrollable text from the specified window.
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Настройки

Captures scrollable text from the specified window.
• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.

• Приложение. Выберите из списка окон, включая окна браузера, которые в настоящее время
открыты на устройстве .

• Браузер. Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based , and  browsers.

• Переменная. Выберите существующую переменную окна, чтобы задать заголовок в
заголовке окна приложения.

• Insert a wildcard character (*) in the Window title field to search for window titles that can change.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

• (Optional) Select the Resize window option to specify the window dimensions.
This option delivers a more reliable . It resizes the window to the dimensions at which the task was
recorded, which enhances the bot's ability to identify the target object.

• Click Capture coordinate to capture the coordinates of the window or a specific control within the
window.

• In the Save captured text to a variable field, select a string variable.

Прим.:  The PowerBuilder application is currently not supported.

Capture text of window action
The Capture text of window action enables you to extract all the text from a window and saves it to a
string variable.
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Настройки

Extracts all the text from a window and saves it to a string variable.
• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.

• Приложение. Выберите из списка окон, включая окна браузера, которые в настоящее время
открыты на устройстве .

• Браузер. Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based , and  browsers.

• Переменная. Выберите существующую переменную окна, чтобы задать заголовок в
заголовке окна приложения.

• (Optional) Select the Resize window option to specify the window dimensions.
This option delivers a more reliable . It resizes the window to the dimensions at which the task was
recorded, which enhances the bot's ability to identify the target object.

• In the Save captured text to a variable field, select a string variable.

Приложение пакет
Use the Open Program/File action in the Приложение пакет to launch an application or a file. This
action supports .exe, .bat, script files, or shortcut paths.

Действия в Приложение пакет

пакет Приложение включает в себя указанные ниже action.

Действие Описание

Открыть программу/файл См. раздел Open program/file action.

Open program/file action
The Open Program/File action in the Приложение enables you to launch an application or a file.

Настройки

Opens an application or file.
• Enter the name of the application or file, or insert a variable. For example, chrome.exe.

Прим.:  You can also enter the full file path in this field.

• Необязательно. Enter the location of the file that you want to use to open the application in the
Start in path field.
For example, C:\Program Files (x86)\Google\Chrome\Application\

• Необязательно. In the Parameters field, specify the parameters or arguments you want to pass to
the program.
For example, if you are using the command line, enter the arguments in this field.
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When you enter a file path in the Location of the program/file field or Start in path field and use a
backslash (\) character to separate the file path, when you save the бот, the backslash (\) character is
changed to forward slash (/). To supports multiple platforms, Automation 360 converts the file paths to a
relative path, and the бот uses a forward slash (/) to separate the file paths.

Прим.:  Your боты will continue to run successfully even when the backslash (\) is changed to a forward
slash (/) during бот execution.

AWS Comprehend NLP пакет
The AWS Comprehend NLPпакет contains actions that enable you to connect to and consume the
Amazon Comprehend API to identify the language, sentiment, key phrases, and entities.

Важное замечание:  This is a beta пакет and is currently not available with the Automation 360
Enterprise and Cloud editions.

Перед началом работы

You require the following information for an existing AWS account to use these actions:
• Access key and Secret key: Credentials that authenticate Automation 360 with your AWS account.

See Access Keys (Access Key ID and Secret Access Key).
• Region: Specifies the AWS service endpoint.

See AWS Service Endpoints.

Действия in the AWS Comprehend NLP пакет

Действие Описание

Detect language Identifies the language of the provided content and returns it in ISO
639-1 language code. The output is stored in a string variable. This action
supports over 100 languages. For the full list, see Detect the Dominant
Language.

Get key phrases Identifies the main points and returns a list of key phrases. For example, if
the input text is about a basketball game, this action returns the names of
teams, the name of the venue, and the final score.

Get named entities Identifies the entities in the provided content such as people, places,
organizations, date/time, quantities, branded products, and book titles.
The output is stored in a dictionary variable, where each name is a key,
and the corresponding entity is the value.

Get sentiment Analyzes the provided content and returns the overall sentiment and
scores for all possible sentiments. An example output of the dictionary
values:
POSITIVE {Positive: 0.66238534,Negative:
 0.0013064129,Neutral: 0.33621928,Mixed: 8.892125E-5}

The output is stored in a dictionary variable containing two keys and their
corresponding values: sentiment and score.
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Boomi action пакет
Boomi Atomsphere is a leading industry on-demand integration service available as a platform-as-a-service
(iPaaS) offering. With the Boomi actions пакет, you can start a session in Boomi from Automation 360 and
perform general tasks in Boomi.

Прим.:  The Boomi package is only available via the Bot Store and is not yet generally available in
Automation 360. This package is currently undergoing final testing, after which it is anticipated to be
generally released as part of Automation 360.

Without extensive training or specialized technical skills, you can build integration flows in Boomi using
drag-and-drop. A multitude of connectors to external systems are available out of the box. It simplifies
typical integration functions such as transforming between various data formats (EDI, CSV, XML, JSON, and
so on) and handling different transport mechanisms (file, FTP, HTTP, and so on). The Boomi action пакет
uses the Boomi APIs to integrate Automation 360 with Boomi.
To perform any action in Boomi using Automation 360,RPA developers need to establish a session with
Boomi. After you establish a session is established, you can execute a process from the Automation 360.
Additionally, you can list the Atoms and Processes.
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Boomi Session Start action
With the Boomi Session Start action, you can connect to a particular Boomi instance using a valid
Account ID to begin a session.
Make sure you have an account to log in to the Boomi Atomsphere Platform. If you are new to Boomi,
go to the Boomi website at Boomi Platform and click the Free Trial link on the banner at the top of the
page.
1. Log in to the Boomi Atomsphere Platform (Boomi Platform).
2. Navigate to Settings > Account Information and Setup.

You will notice the Account ID.
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3. Copy the Account ID.
4. Log in to the Automation 360 Control Room.
5. Create a new .

a) Выполните вход в экземпляр .
b) На левой панели щелкните Автоматизация.
c) Щелкните Создать > Бот.
d) In the Create Task Bot window, enter the  name.
e) Accept the default folder location: \Bots\

To change the default  storage location, click Choose and follow the prompts.
f) Щелкните Создать и редактировать.
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6. From the Actions pane, select Boomi > Session Start and place it under the Start of the бот flow.
Boomi information Вариант

Boomi Account ID/Boomi Login/ Boomi
password

Select one of the following options to specify
the Boomi Account ID/Boomi Login/Boomi
password:
• Учетные данные. Enables you to use a

value available in the Credential Vault that
contains information about the Boomi Account
ID/Boomi Login/Boomi password.

• Переменная. Enables you to use a
credential variable that contains information
about the Boomi Account ID/Boomi Login/
Boomi password.

• Insecure string: Enables you to enter
the Boomi Account ID/Boomi Login/Boomi
password for the Boomi Session Start.

a) In the Boomi Account ID field, paste the Account ID copied from the Boomi Atomsphere
Platform.

b) In the Boomi Login field, enter the Email Address used to log in to the Boomi Atomsphere
Platform.

c) In the Boomi Password field, enter the Password used to log in to the Boomi Atomsphere
Platform.
The following example shows how Insecure string is used for the Session Start information. For
better security, you can use either the Credential or Variable options.
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Boomi List Atoms action
With the Boomi List Atoms action, you can list all the Atoms associated with a Boomi instance.

Прим.:  Ensure that you have started a Boomi session before initiating any Boomi action. For more
details, see Boomi Session Start action.
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An Atom is a single tenant runtime engine and cannot be used by multiple accounts. It is a light-weight
Java application that runs on a single node only and does not provide high availability. The following
procedure describes how to list all the Atoms of a Boomi instance:
1. From the Actions pane, select Boomi > List Atoms and place it in the canvas.

2. Make sure the Session name field is set to Default. Default uses the current session that has been
established using the Boomi Session Start action.

3. Create a variable to store the response. In this example, the response is saved in a variable named
jListAtoms.

You can use a message box action to view the list of Atoms. The message box displays the list of Atoms
similar to the following image:
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Boomi Convert Atom list to CSV action
With the Boomi Convert Atom List to CSV action, you can convert an Atom list associated with a Boomi
instance into a CSV format.

Прим.:  Ensure that you have started a Boomi session before initiating any Boomi action. For more
details, see Boomi Session Start action.
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The following procedure describes how to convert an Atom list to CSV in a Boomi instance:
1. From the Actions pane, select Boomi > Convert Atom List to CSV and place it in the canvas.

2. Enter a JSON Atom List stored in a variable. For more information on storing a JSON Atom List, see
Boomi List Atoms action.

3. Create a variable to store the response. In this example, the response is saved in a variable named
AtomCSV.

You can use a message box action, to view the CSV. The message box displays the list of Atoms converted
into a CSV similar to the following image:
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Boomi List Processes action
With the Boomi List Processes action, you can list all the Processes associated with a Boomi instance.
The process is the central component in Boomi Integration.

Прим.:  Ensure that you have started a Boomi session before initiating any Boomi action. For more
details, see Boomi Session Start action.

A process is a graphical representation of the path that a document takes from the point at which it is
received or retrieved to the point at which it is sent to one or more destinations. Processes in Boomi are
depicted with a left-to-right series of shapes and connected together similar to a flow chart. It illustrates
the steps required to transform, route, or manipulate the data from the source to the destination.
Processes use connectors to retrieve and send data. Processes are deployed to the atom (a dynamic
runtime engine). Once processes have been deployed, the atom contains all the components required to
execute the integration processes from start to finish including:
• Connectors
• Transformation rules
• Decision handling
• Processing logic
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The following procedure describes how to list all the Processes of a Boomi instance:
1. From the Actions pane, select Boomi > List Processes and place it in the canvas.

2. Make sure the Session name field is set to Default. Default uses the current session that has been
established using the Boomi Session Start action.

3. Create a variable to store the response. In this example, the response is saved in a variable named
jListProcesses.

You can use a message box action, to view the list of Processes. The message box displays the list of
Processes similar to the following image:
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Boomi Convert Process List to CSV action
With the Boomi Convert Process List to CSV action, you can convert a Process list associated with a
Boomi instance into a CSV format.

Прим.:  Ensure that you have started a Boomi session before initiating any Boomi action. For more
details, see Boomi Session Start action.
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The following procedure describes how to convert a Process list to CSV in a Boomi instance:
1. From the Actions pane, select Boomi > Convert Process List to CSV and place it in the canvas.

2. Enter a JSON Process List stored in a variable. For more information on storing a JSON Processes List,
see Boomi List Processes action.

3. Create a variable to store the response. In this example, the response is saved in a variable named
ProcessesCSV.

You can use a message box action, to view the CSV. The message box displays the list of Processes
converted into a CSV similar to the following image:
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Boomi Convert Process List to Table action
With the Boomi Convert Process List to Table action, you can convert a Process list associated with a
Boomi instance into a Table format.

Прим.:  Ensure that you have started a Boomi session before initiating any Boomi action. For more
details, see Boomi Session Start action.
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The following procedure describes how to convert a Process list to table in a Boomi instance:
1. From the Actions pane, select Boomi > Convert Process List to Table and place it in the canvas.

2. Enter a JSON Process List stored in a variable. For more information on storing a JSON Process List,
see Boomi List Processes action

3. Create a variable to store the response. In this example, the response is saved in a variable named
ProcessesTable.

You can use a message box action, to view the CSV. The message box displays a cell from the list of
Processes converted into a Table similar to the following image:
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Boomi Execute Process action
With the Boomi Execute Process action, you can execute a process associated with a Boomi Atom.

Прим.:  Ensure that you have started a Boomi session before initiating any Boomi action. For more
details, see Boomi Session Start action.

The following procedure describes how to execute a process associated to a Boomi atom:
1. From the Actions pane, select Boomi > Execute Process and place it in the canvas.

2. Make sure the Session name field is set to Default. Default uses the current session that has been
established using the Boomi Session Start action.

3. In the Process ID field, enter a process ID that you want to execute. For more information on
retrieving the process ID, see Boomi List Processes action.
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4. In the Atom ID field, enter an atom ID to which the process is associated. For more details, see
Boomi List Atoms action.

5. In the Process Properties field (optional), enter the process properties you want to edit.

You can save the response into a variable. In this example, the response is saved in a variable named
ExecuteProcess. Use a message box to view the content of the variable. The API response is converted
into a string before it is passed to the message box. The message box displays the execute process
response of the similar to the following image:

Boomi List Execution Records action
With the Boomi List Execution Records action, you can list all the execution records associated with a
Boomi instance.

Прим.:  Ensure that you have started a Boomi session before initiating any Boomi action. For more
details, see Boomi Session Start action.
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The following procedure describes how to list the execution records of a Boomi instance:
1. From the Actions pane, select Boomi > List Execution Records and place it in the canvas.

2. Make sure the Session name field is set to Default. Default uses the current session that has been
established using the Boomi Session Start action.

3. Create a variable to store the response. In this example, the response is saved in a variable named
ExecutionRecords.

You can use a Data Table: Write to file action, to view the execution records.

© 2023 Automation Anywhere. All rights reserved.     1433



    Automation Anywhere - Сборка

Boomi Session End
With the Boomi Session End action, you can end an established Boomi session.

Прим.:  Ensure that you have started a Boomi session before initiating any Boomi action. For more
details, see Boomi Session Start action.

The following procedure describes how to end an existing session of a Boomi instance:
1. From the Actions pane, select Boomi > Session End and place it at the end of the бот flow.

2. Make sure the Session name field is set to Default. Default uses the current session that has been
established using the Boomi Session Start action.

Boolean пакет
The Boolean пакет contains actions that enable you to do various operations on boolean values.

Действия in the Boolean пакет

The actions in the Boolean пакет accept a variable as an input and assign the output to a variable. These
actions enable you to compare two boolean values, convert a boolean value to a string or numeric value,
and convert a string value to a boolean value.
The Boolean package includes the following actions:
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Действие Описание

Присвоить См. Assign action in Логический

Сравнить с См. Compare to action in Логический

Равно См. Equal to action in Логический

Инвертировать См. Invert action in Логический

В число См. To number action in Логический

В строку См. To string action in Логический

Compare results for the Compare to action
The following table illustrates how two boolean values are compared using the Compare to action and
their output:

Boolean value 1 Boolean value 2 Compare result

True True 0

True False 1

False True -1

False False 0

Compare results for the Equal to action
The following table illustrates how two boolean values are compared using the Equal to action and their
output:

Boolean value 1 Boolean value 2 Equal result

True True True

True False False

False True False

False False True

Assign action in Логический
The Assign action in the Логический пакет enables you to assign a constant value (True or False) or a
user-defined value to a boolean value.

Настройки

• In the Select the source boolean variable/value field, select one of the following options:
• Constant values: Enables you to assign a constant value (True or False).
• Variable value: Enables you to assign a user-defined value to a boolean value.

• In the Select the destination boolean variable field, select a boolean variable to store the output.
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Compare to action in Логический
The Compare to action in the Логический пакет enables you to compare two Boolean values and assigns
the output to a number variable.

Настройки

• In the Select the first boolean variable field, specify a boolean variable.
• In the Select the second boolean variable field, specify a boolean variable that the first boolean

variable has to be compared with.
• In the Assign the output to a number variable field, select a variable to store the output.

Equal to action in Логический
The Equal to action in the Логический пакет enables you to verify whether the two boolean values are
equal or not, and assigns the output to a boolean variable.

Настройки

• In the Select the first boolean variable field, specify a boolean variable.
• In the Select the second boolean variable field, specify a boolean variable that the first boolean

variable has to be compared with.
• In the Select the boolean variable to store the result field, select a variable to store the output.

Invert action in Логический
The Invert action in the Логический пакет enables you to convert a boolean value to the opposite value
(True to False and False to True), and assigns the output to a variable.

Настройки

• In the Select the boolean variable to be inverted, select the boolean value to convert. Choose
from False, True, or a Variable.

• In the Assign the output to field, select a boolean variable to store the converted value.

To number action in Логический
The To number action in the Логический пакет enables you to convert a boolean value to a numeric
value. This action converts True to 1 and False to 0.

Настройки

• In the Select boolean variable field, select the boolean variable that you want to convert.
• In the Assign the output to variable field, select the number variable to store the converted value.

To string action in Логический
The To string action in the Логический пакет enables you to convert a boolean value to a string value.
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Настройки

• In the Select boolean variable field, select the boolean variable that you want to convert.
• In the Assign the output to variable field, select the number variable to store the converted value.

Бот migration пакет
The Bot migration пакет enables you to migrate Enterprise 10 and Enterprise 11 боты to Automation
360 format. The пакет also enables you to convert Enterprise 10, Enterprise 11, or Automation 360
боты that use Internet Explorer to Microsoft Edge with IE mode. This пакет is used internally by the Bot
Migration Wizard and the Update Bot wizard.
См. раздел Поддерживаемые для миграции версии Control Room.

Важное замечание:  We recommend that you use the Bot Migration Wizard to migrate Enterprise 11 or
Enterprise 10 боты to Automation 360.
The Bot migration пакет does not migrate dependencies and other entities such as credential variables,
AAApplicationPath system variable, and global values that are required to run the migrated бот.

Действие in the Bot migration пакет

The Bot migration пакет includes the following action:

Действие Описание

Migrate legacy бот See Migrate legacy bot action.

Update бот See Update bot action.

Понятия, связанные с данным
Миграция в Automation 360

Migrate legacy бот action in Bot Migration
The Migrate legacy бот action enables you to migrate the Enterprise 11 and Enterprise 10 бот files to
Automation 360 format and uploads the migrated file to the specified location in your private repository
with the same name as .atmx and .mbot file.

Настройки

Starting from Automation 360 v.24R2 release for IE EOL, the Migrate bot action is renamed as Migrate
legacy bot.
This action only migrates the бот you specify, but does not migrate its dependencies. Dependencies
are the боты and other files that are required to run the бот. You must migrate the dependent боты
separately and upload other files manually to Control Room.
All the боты migrated using the Bot migration пакет are stored in the Bots folder in Automation 360.
If you have to migrate a parent бот and its child боты separately using the Bot migration пакет, you
must create the same folder structure as in Enterprise 11 or Enterprise 10 and move the dependent боты
to these folders for the parent бот to run successfully.
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• Use the Control Room file, Desktop file, or Variable tab to specify the location of the бот you want
to migrate.

• In the Output folder path field, specify the location where you want to save the log files generated
for the бот migration.

Прим.:  Ensure that the location you have specified exists on the device.

The system does not upload the бот if it fails during the migration process. The system creates an
XML report at the same location that provides information that helps you to troubleshoot if the system
encounters an error during migrating the бот file.

• Select the Overwrite the file if exists check box to overwrite an existing бот file.
• Set a time-out value for migrating the боты within the range of 3 through 90 minutes (default value is

90 minutes).
If the migration of any specific бот is not completed within the set time, the бот will display a timeout
message with the reason for the failure and the migration process will move on to the next бот.

• If you are migrating Enterprise 10 and Enterprise 11 боты that are built using Internet Explorer, select
the Convert bots built using Internet Explorer to Edge with Internet Explorer mode option to
convert them to Microsoft Edge with IE mode.

Update бот action in Bot Migration
The Update bot action enables you to convert Automation 360 боты that are built using Internet Explorer
browser to Microsoft Edge Chromium with IE mode.

Настройки

This action is internally used by the Update Bot wizard to convert the боты .

Прим.:  This action cannot be used manually in a new or an existing бот for бот conversion.

• From the Select task bot file field, enter the name of the TaskBot file that you want to upload or
select an existing used variable.

• From the Select bot version to update option, select either the latest version of the бот or the бот
version that is provided on the production label.

Браузер пакет
пакет Браузер содержит actions, которые позволяют загружать файлы, находить неработающие
ссылки и запускать веб-сайт. Этот пакет поддерживает браузеры Google Chrome, Microsoft Edge на
базе Chromium и Internet Explorer.

Действия в Браузер пакет

пакет Браузер включает в себя указанные ниже actions.

Действие Описание

Call a JavaScript
function

См. Call a JavaScript function action

Close See Close action

Загрузить файлы См. Download files action
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Действие Описание

Найти неработающие
ссылки

См. Using Find broken links action

Получить исходный
код

См. Get source code action

Назад См. Go back action

Открыть См. Open action

Выполнить JavaScript См. Run JavaScript action

Прим.:
• Когда вы выполняете любое action из пакет Браузер на вкладке браузера Internet Explorer, если

в одном окне браузера открыто несколько вкладок с одинаковым заголовком, поиск подходящего
заголовка выполняется непоследовательно, начиная с первой вкладки. В этом случае активация
вкладки и action браузера в этом случае могут выполняться на разных совпадающих вкладках.

• Если вкладки с одинаковым заголовком встречаются в разных окнах, то action выполняется на
вкладке с соответствующим заголовком в любом окне.

Call a JavaScript function action
The Call a JavaScript function action in the Браузер пакет enables you to call an exisiting JavaScript
function directly in a webpage or in an iFrame within a webpage.

Configure the settings

Прим.:  This action supports Google Chrome and Chromium-based Microsoft Edge browsers.

1. Select the browser tab from the list of active supported browser tabs or insert a window variable.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.
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• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

2. Необязательно. Используйте Сделать снимок объекта для записи элементов iFrames.

Прим.:  You can use the Capture object feature to call and run an existing JavaScript function
inside an iFrame.

3. In the Function name field, specify the name of the existing JavaScript function that you want to
call.

4. Необязательно. In the Arguments section, click Add argument to add arguments that must be
passed to call the JavaScript function.
a. In the Argument details dialog box, select the Argument type required for the specific

argument.
b. In the value field, enter the corresponding value or variable of the selected type that you want to

pass.

Прим.:  All string values in arguments are passed as is without any character being converted or
escaped.

5. Необязательно. In the Time out after field, enter the number of seconds the бот must wait for
the browser action to complete.

Прим.:  Введите значение времени ожидания не менее 9 секунд.

6. In the Return Type field, select the type of value returned by the JavaScript function.

Прим.:  If the function does not return anything, in the Return Type field, select None.

7. For any Return type except None, in the Save the outcome to a variable field, select a variable
for selected Return type to hold the JavaScript function output.

Создать переменную

To create a variable for selected Return type, perform the following steps:
1. Click the Create variable symbol next to the Save the outcome to a variable field.

A Create variable dialog opens with default variable name for the type of variable selected.
2. Необязательно. Specify the variable information in the Description field.
3. Необязательно. Specify a value in the Default value field.
4. Click Create & select to select the newly created variable.

© 2023 Automation Anywhere. All rights reserved.     1440



    Automation Anywhere - Сборка

Supported JavaScript types in Argument and Return type fields

The following JavaScript types are supported:
• String, Number, and Boolean JavaScript types which correspond to the same variable types in бот

variables.
• Array JavaScript type which corresponds to the List variable type in бот variables.
• Object JavaScript type which corresponds to the Dictionary variable type in бот variables.

Close action
Use the Close action in the Браузер пакет to close a browser window or tab.

Настройки

Прим.:  Этот  поддерживает браузеры ,  на базе Chromium и .

• Выберите, чтобы закрыть вкладку, окно или все браузеры:
• Вкладка: Закрывает выбранную вкладку. Выберите вкладку браузера из списка активных

поддерживаемых вкладок браузера или вставьте переменную окна.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will
be identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names
starting with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only
those window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that
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when you add the string input as *-title, the application with the specific title is open. The
asterisk (*) is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a
window title in any , the  might encounter a run time error because the input value *-title is
incorrect.
Ensure that you use valid regex patterns.

• Окно: Закрывает окно выбранной вкладки. Select the window from the list of active supported
windows or insert a window variable.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will
be identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names
starting with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only
those window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that
when you add the string input as *-title, the application with the specific title is open. The
asterisk (*) is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a
window title in any , the  might encounter a run time error because the input value *-title is
incorrect.
Ensure that you use valid regex patterns.

• Все браузеры: Closes all open browser windows for supported browsers.

• Необязательно. В поле Отключение через введите количество секунд, которое бот должен
подождать, пока окно браузера или вкладка закроется, прежде чем произойдет сбой бот.

Прим.:  Введите значение времени ожидания не менее 9 секунд.

Download files action
The Download files action in the Браузер пакет downloads and saves files from specified URLs and URLs
that require NTLM authentication.

Настройки

Загружает файлы с указанных URL-адресов и URL-адресов, требующих аутентификации NTLM, и
сохраняет их.
• Укажите URL-адрес файла для загрузки.
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• В поле Сохранить в папку введите путь к месту сохранения файла.

Using Find broken links action
The Find broken links action finds broken links on a specific page or website, stores the output to a CSV
file. Optionally, you can specify encoding for the output data.
Follow these steps to find broken links:
1. In the Действия palette, double-click or drag the Find broken links action from the Браузер

пакет.
2. In the Page or URL field, enter the URL of the page or website.
3. In the Scope option, choose either check only this page or check the whole site.
4. In the Save list to location field, specify the location of the CSV file.
5. Select the Append to already existing csv file check box if you want to append the data to an

existing CSV file.
6. Выберите параметр из списка Кодировка, чтобы указать кодировку для файла.

• ANSI
• Юникод
• UTF-8

7. In the Number of parallel threads field, enter the number of parallel threads you want to run
simultaneously.
Parallel threads means multiple processes running simultaneously to perform the same task which
results in faster execution. Higher the number of parallel threads faster the execution of a task
execution. For example, if 10 threads complete a task in two minutes, 20 threads compete a task in
one minute.

Прим.:  The maximum value you can provide in the field is 99.

8. In the Time out field, specify the maximum time the system must wait to receive a response from
each URL link.

9. Щелкните Сохранить.

Get source code action
The Get source code action retrieves the source code of a web page and an iFrame on a web page and
saves the output to a string variable.

Настройки

Прим.:  Этот  поддерживает браузеры ,  на базе Chromium и .

• Выберите вкладку браузера из списка активных поддерживаемых вкладок браузера или вставьте
переменную окна.

• Необязательно. Используйте Сделать снимок объекта для записи элементов iFrames.

Прим.:
• Функция Сделать снимок объекта используется только для получения исходного кода

iFrame. Если вы не создаете снимок чего-либо в окне, будет получен исходный код всего окна.
• Получение исходного кода iFrame доступно только в браузере Google Chrome.
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• Необязательно. In the Time out after field, enter the number of seconds the  must wait for the
browser action to complete.

Recommended:  Введите значение времени ожидания не менее 9 секунд.

• Необязательно. Выберите переменную для сохранения выходных данных . В  отображается
описательное имя переменной по умолчанию. If you create several output variables, subsequent
variable names are appended with a -1, -2, -3, and so on to avoid duplication.

Go back action
The Go back action returns to a web page previously visited in the current tab. Это action имитирует
щелчок на кнопке браузера Назад.

Настройки

Прим.:  Этот  поддерживает браузеры ,  на базе Chromium и .

• Выберите вкладку браузера из списка активных поддерживаемых вкладок браузера или вставьте
переменную окна.

Прим.:  При выборе вкладки Internet Explorer из списка активных вкладок, и если заголовок
выбранной вкладки или любой промежуточной вкладки при выполнении action Назад
содержит более 60 символов, то первые 60 символов используются для сравнения, чтобы найти
подходящий заголовок вкладки.

Recommendation:  При выполнении action на вкладке браузера убедитесь, что в окне
браузера открыта только одна вкладка с соответствующим заголовком вкладки. Эта настройка
гарантирует, что при выполнении action не существует промежуточного заголовка вкладки,
совпадающего с другим заголовком вкладки в том же окне.

• В поле Число шагов назад введите количество страниц для возврата назад.
• Необязательно. Выберите параметр Вызывает ошибку, если количество шагов

превышает историю, чтобы работа бот завершилась с ошибкой, если число, введенное в ходе
выполнения предыдущего шага, превышает число посещенных страниц.
Если не выбрать этот параметр, при запуске бот вкладка будет возвращаться на первую
открытую веб-страницу.

• Необязательно. In the Time out after field, enter the number of seconds the  must wait for the
browser action to complete.

Recommended:  Введите значение времени ожидания не менее 9 секунд.

Open action
The Open action opens the browser to a specific web page.

Настройки

• Выберите, чтобы открыть веб-страницу в существующей вкладке, новой вкладке или новом окне:
• Существующая вкладка: Открывает веб-страницу на текущей открытой вкладке. Select the

tab from the list of active supported browser tabs, the Last used browser tab option, or insert a
window variable.
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Прим.:  This option supports , Chromium-based , and  browsers.

Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will
be identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names
starting with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only
those window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that
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when you add the string input as *-title, the application with the specific title is open. The
asterisk (*) is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a
window title in any , the  might encounter a run time error because the input value *-title is
incorrect.
Ensure that you use valid regex patterns.

• Новая вкладка: Открывает веб-страницу на новой вкладке. Выберите вкладку из списка
активных поддерживаемых вкладок браузера или вставьте переменную окна.

Прим.:
• Этот параметр поддерживает браузеры Google Chrome, Microsoft Edge на базе Chromium и

Internet Explorer.
• Когда вы выполняете action на вкладке Internet Explorer, то action выполняется на

соответствующей вкладке, только когда она находится в состоянии готовности.

Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will
be identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names
starting with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only
those window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that
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when you add the string input as *-title, the application with the specific title is open. The
asterisk (*) is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a
window title in any , the  might encounter a run time error because the input value *-title is
incorrect.
Ensure that you use valid regex patterns.

• Новое окно: Открывает веб-страницу в новом окне определенного браузера.
Выберите браузер из перечисленных ниже вариантов:
• Браузер по умолчанию

Убедитесь, что в качестве браузера по умолчанию установлен Google Chrome, Microsoft
Edge или Internet Explorer.

Прим.:  Если на устройстве в качестве браузера по умолчанию установлен какой-либо
браузер, не указанный в списке, бот может выдать ошибку.

• Google Chrome
• Internet Explorer
• Microsoft Edge
• Mozilla Firefox

• Введите ссылку на веб-страницу, которую нужно открыть.

Прим.:  For web pages to open properly, we recommend that you specify a URL with the protocol
information, such as http, https, or file.

• Необязательно. В поле Отключение через введите количество секунд, которое бот должен
подождать, пока указанная веб-страница загрузится, прежде чем выполнение бот завершится с
ошибкой.

Прим.:  Введите значение времени ожидания не менее 9 секунд.

Прим.:
• Отключение по истечении времени ожидания применяется только для параметров Новая

вкладка и Существующая вкладка опции.
• Для браузера Internet Explorer бот выполняется, даже если веб-страница не была полностью

загружена по истечении времени ожидания.

Run JavaScript action
The Run JavaScript action in the Браузер пакет executes JavaScript on a web page and on web pages
that have iFrames.

Настройки

Прим.:
• This action supports Google Chrome and Chromium-based Microsoft Edge browsers.
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• When you use this action to execute a JavaScript that contains a single-line comment as the last line
of the JavaScript (for example, //comment), it can cause the Automation Anywhere plugin to become
unstable. We recommend that you either remove the comment at the end of the JavaScript or convert it
to a multi-line comment (for example, /* comment */).

• Select the browser tab from the list of active supported browser tabs or insert a window variable.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

• Choose one of the following options:
• In the Import existing file option, select an existing  file.

Прим.:  If you are uploading a script from a file on your desktop, the file and any dependencies
must be in a standalone folder. When you select a file for upload, all files and folders at the same
folder level are uploaded.

• In the Manual input option, enter the .

• Необязательно. Используйте Сделать снимок объекта для записи элементов iFrames.

Прим.:
• Функция Сделать снимок объекта используется только для выполнения JavaScript внутри

iFrame.
• Поддержка выполнения JavaScript внутри iFrame доступна только в браузере Google Chrome.

• Необязательно. In the Time out after field, enter the number of seconds the  must wait for the
browser action to complete.

Recommended:  Введите значение времени ожидания не менее 9 секунд.
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• Необязательно. In the Save the outcome to a variable field, select a variable to hold the action
output. В Control Room отображается описательное имя переменной по умолчанию. If you create
several output variables, subsequent variable names are appended with a -1, -2, -3, and so on to
avoid duplication.

Прим.:  This action supports String, Number, and Boolean JavaScript types which correspond to the
same variable types in бот variables, or to the бот variable type Any.

Recommendation:
• Не используйте Jquery с пакет JavaScript.
• Используйте actions Попробовать/Выявить из Обработчик ошибок в функции JavaScript.
• Вызовите функцию JavaScript до ее объявления.

Watch the following video on using the Run JavaScript action from the Browser package to execute
JavaScript directly within an existing browser window:

Информация, связанная с данной
Executing a JavaScript function on Chrome (A-People login required)

Буфер обмена пакет
The Буфер обмена пакет contains actions that enable you to automate using the Windows clipboard. Use
the actions to copy a string value to the clipboard, copy the clipboard value to a string variable, and clear
the clipboard.

Действия в Буфер обмена пакет

пакет Буфер обмена включает в себя описанные ниже actions.

Действие Описание

Очистить См. раздел Clear action in Буфер обмена.

Копировать из См. раздел Copy from action in Буфер обмена.

Копировать в См. раздел Copy to action in Буфер обмена.

Clear action in Буфер обмена
The Clear action in the Буфер обмена пакет enables you to clear the clipboard.

Настройки

This action will remove any value that is stored in the clipboard.

Copy from action in Буфер обмена
The Copy from action in the Буфер обмена пакет enables you to retrieve the values stored in the
clipboard.

© 2023 Automation Anywhere. All rights reserved.     1449

https://apeople.automationanywhere.com/s/article/Executing-a-JavaScript-function-on-Chrome-Browser-using-A360


    Automation Anywhere - Сборка

Настройки

This action enables you to retrieve the values stored in the clipboard and store it in the string variable that
you select from the Assign the output to variable list. This action also enables you to pass the value
from the clipboard to other actions.

Copy to action in Буфер обмена
The Copy to action in the Буфер обмена пакет enables you to store values in the clipboard.

Настройки

You can either enter the value or specify the string variable that contains the value in the Value field.

пакет «Учетные данные»
Используйте action Присвоить в пакет «Учетные данные» для присвоения небезопасной строки или
переменной непосредственно переменной учетных данных.

Действия в пакет «Учетные данные»

пакет «Учетные данные» включает в себя указанное ниже action.

Прим.:
• The credential variables support the retry mechanism. When you create a бот that uses credential

variables, if the бот fails during run time to retrieve those variables from the Credential Vault because
the Control Room is disconnected or the Control Room services stop intermittently, then the бот tries
three times to retrieve the credential variables from the Credential Vault.

• While the Convert credential to string action is listed on the Credential пакет details page, it is not
available for use from the actions list in the Bot editor. This is because the action should be used only
for migration and not for other scenarios because it introduces a security risk.

Действие Описание

Присвоить Задает значение переменной учетных данных.
• Можно выбрать Учетная запись, чтобы использовать значение

из Credential Vault, Переменная, чтобы использовать переменную
учетных данных, или Небезопасная строка для ручного ввода
переменной.

• В поле Сохранить результат в переменной выберите
переменную для хранения возвращаемого значения.

CSV/TXT package
The CSV/TXT package contains actions that enable you to open a CSV or text file, read data from that
file, and assign the data to a Table variable. This package supports files encoded in ANSI, Unicode, UTF-8,
or Windows-1251, and can process up to one million records.
Perform the following actions within the CSV/TXT package as part of using the set of available actions:
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1. Open the file to be used in the automation. См. Using the Open action for CSV/TXT file.

Прим.:  For files containing large data sets, use actions from the База данных пакет to automate
create, read, and update operations. См. раздел Использование action «Подключить» для базы
данных.

2. Use the Read action to retrieve values from a CSV or TXT file and store them in a Table variable. См.
раздел Using Read action.
To retrieve values row by row, use the For each row in CSV/TXT iterator in the Цикл action to read
values from each row in the file and assign it to a record variable. См. раздел Using the For each row in
CSV/TXT iterator.

Прим.:  The Read action and For each row in CSV/TXT iterator only support CSV/TXT files that
conform to the RFC 4180 standard. For more information about the standard, see Common format and
MIME type for CSV files.

3. After you have automated the CSV/TXT-related tasks, close the file using the Close action. Enter the
session name that was used to open the file with the Open action.

Ссылки, связанные с данной
Цикл пакет
Use the Цикл package to run a sequence of actions repeatedly for a specific number of times or until a
specific condition is met.
Your variables (user-defined)
Users and some actions create user-defined variables to temporarily hold values. Use this kind of variable
to input values into an action (window title, login credential, or file path) or to accept the output of an
action (values read from a file or a Boolean return).

Using the Open action for CSV/TXT file
This action enables you to specify the delimiter used in the file, whether to trim the spaces, and the
encoding applied on the file.

Прим.:  If there is a double quotation mark (") in the last element of the last line of the CSV/TXT file, at
runtime the бот will encounter an error.

To open a CSV or text file, do the following:
1. Double-click or drag the Open action from the CSV/TXT пакет in the Actions palette.
2. Select any of the following options to specify the location of the CSV or text file to open:

• Control Room file: Enables you to open a file from the .
• Desktop file: Enables you to open a file from the device. This field also accepts the file path input

as a string variable or global value.

Прим.:  When you enter a file path in the Desktop file field or browse a particular file from
the system, wherein the file path is separated by the \ character and save the , the \ character is
changed to / as the  uses / to separate file paths. Your  continue to run successfully even if the \ is
changed to / during  execution.

• Переменная. Enables you to open a file by specifying a file variable.

3. Select the Contains header check box if the file contains a header row and you want to retrieve
values from that row.

4. Select any of the following options to specify the Delimiter used in the file:
• Comma
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• Tab
• Regional list separator: Enables you to specify the delimiter as configured in the regional

settings of the Windows operating system. If the List Separator in the Windows regional settings
is modified, then the CSV file should also contain that character as a delimiter.

• Newline
• Other: Enables you to specify a delimiter other than the options listed above.

5. Select the Trim leading and Trim trailing check boxes to remove the leading and trailing spaces
from the data extracted from the CSV/TXT file

6. Select an option from the Encoding list to specify the encoding that is applied on the file. Data from
the CSV/TXT file will be retrieved based on the selected encoding option even if the input file has a
different encoding.
• ANSI: Used to encode Latin alphabet.
• UTF8: Can encode all possible characters.
• UNICODE
• Win1251: used to encode languages that use the Cyrillic script, including Bulgarian, Russian, and

Serbian.
• UTF-16LE: ignores the byte order mark (BOM) Unicode character at the beginning of file.
• Default: identifies file encoding. This option supports UTF-8, UTF-16LE, and UTF-16BE file

encoding.

Прим.:  Shift-JIS files must use ANSI as encoding to read text file content.

7. Щелкните Сохранить.

Use the Read action to retrieve the data from CSV/TXT file and assign them to a table variable. You can
use the loop action to retrieve each row of data from the file or table variable and assign them to the
record variable for further operations.
• Using Read action
• Using the For each row in CSV/TXT iterator

Using Read action
Use the Read action to retrieve values from a CSV or TXT file, and insert them into a Table variable to
perform operations with the data values.

Прим.:
• The Read action only support CSV/TXT files that conform to the RFC 4180 standard. For more

information about the standard, see Common format and MIME type for CSV files.
• When you use the Read action to read data from a CSV or TXT file that contains double quotes, the

бот might display an error message: Unable to read the file and create a table. We
recommend that you replace all double quotes with an empty or a blank character.

To retrieve values from a CSV or TXT file, do the following:
1. Double-click or drag the Read action from the CSV/TXT node in the Actions palette.
2. Enter the name of the session that you have used to open the CSV or text file in the Open action.
3. Select a Table variable from the Assign value to the variable list.

Create a variable if it does not already exist. В  отображается описательное имя переменной по
умолчанию. If you create several output variables, subsequent variable names are appended with a
-1, -2, -3, and so on to avoid duplication.
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Прим.:  A бот can return only a maximum of 3 MB to an output variable.
Обходное решение. Store the бот output on the device, such as in a .txt file. If the output must be
shared across multiple Bot Runner, store the output in a shared drive.

Perform operations with the values in the Table variable using the Таблица данных пакет.

Комментарий пакет
Use the Комментарий пакет to insert a user-specified comment into your бот logic.

Действие в Комментарий пакет

пакет Комментарий включает в себя указанные ниже action.

Действие Описание

Комментарий Inserts a comment.

Прим.:  A comment is saved and displayed as a single line. A comment
with multiple lines is displayed as a single line, followed by an ellipsis when
the comment is saved. Comments are ignored when the бот runs.

Таблица данных пакет
The Таблица данных пакет contains actions that enable you to perform various operations on the values
of table variables. Use these actions to join or merge content, search for specific values, insert rows and
columns, remove duplicate rows, and write values to a file.

Действия в Таблица данных пакет

пакет Таблица данных включает в себя описанные ниже actions.

Прим.:  If you built a бот using actions from the Таблица данных пакет from Сборка 5322 or earlier,
the actions will be missing when you open the бот with the default пакет version. You must reinsert the
actions and repopulate the fields.

Действие Описание

Присвоить Assign action.

Change column type Change column type action.

Очистить содержимое Clear content action.

Удалить столбец Delete column action.

Удалить строку Delete row action.

Получить число
столбцов

Get number of columns action.
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Действие Описание

Получить число строк Get number of rows action.

Вставить столбец Insert column action.

Вставить строку Insert row action.

Соединить Using Join action.
Use the Join type output examples to help you decide whether to use the
Join or Merge action.

Прим.:  If you built a бот using this action from пакет version
2.0.0-20200624-042148 or earlier, the action will be missing when you
open the бот with the default пакет version. You must reinsert the action
and repopulate the fields.

Объединить Using the Merge action.
Use the Merge output example to help you decide whether to use the Join
or Merge action.

Прим.:  If you built a бот using this action from пакет version
2.0.0-20200624-042148 or earlier, the action will be missing when you
open the бот with the default пакет version. You must reinsert the action
and repopulate the fields.

Удалить
повторяющиеся строки

Remove duplicate rows action.

Поиск значения Search for a value action.

Установить значение
одной ячейки

Set value of a single cell action.

Сортировать Sort action.

Записать в файл Использование действия «Записать в файл».

Example:  Example of extracting data from a web table

Assign action
The Assign action in the Таблица данных пакет enables you to assign values to a table variable.

Настройки

You can use this action to manually enter the table data.
• Select whether to create a table with or without values.

• If you select to create a table with values, either manually enter the values or select a source table
variable.

• If you select to create a table without values, specify the number of rows and columns.
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• Select a table variable to hold the output. You can either select the source table variable to overwrite
the values, or select a different table variable.

Change column type action
The Change column type action in the Таблица данных пакет enables you to change the data type of a
column.

Настройки

• Select the data table name from the drop-down list.
• Select whether to specify the column by Name or Index.

• If you select to specify by name, enter the column name.
• If you select to specify by index, enter the column index. For example, to set a value to the first

column, enter 0.

• Select the new column data type from the drop-down list to Number, Boolean, String, or Datetime.
• If you select Datetime, you can format the values by selecting a predefined format or specifying a

custom format.
• To specify the format applied on the input data table variable, select an option either from the

predefined format list or enter the value in a custom format.

• Select a table variable to include the output.
You can either select the source table variable to overwrite the values or select a different table
variable.

Clear content action
The Clear content action in the Таблица данных пакет enables you to clear the contents of the specified
table variable.

Настройки

This action clears the content until the execution of the бот is completed. After the бот execution is
completed, the original values of the table variables are restored.
This action enables you to reuse an existing table variable to store values that are used only during the бот
execution.

Прим.:  The data type of the values must be same as the data type of the columns in the table variable.

Delete column action
The Delete column action in the Таблица данных пакет enables you to delete a specific column.

Настройки

• Select the Table variable name from the drop-down list.
• Specify the column name or column index to delete.
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Прим.:  The index count starts from 0.

Delete row action
The Delete row action in the Таблица данных пакет enables you to delete a specific row.

Настройки

Прим.:  If the data table values were read from an Excel sheet, and you selected the Sheet contains a
header option in the Open action, you cannot delete cells from the first row.

• Select the Table variable name from the drop-down list.
• Specify the row name or row index to delete.

Прим.:  The index count starts at 0.

Get number of columns action
The Get number of columns action in the Таблица данных пакет enables you to retrieve the number of
columns from a table.

Настройки

Retrieves the number of columns and assigns it to a Number variable. You have the option to select the
non-empty columns or include all the columns in the selection.

Get number of rows action
The Get number of rows action in the Таблица данных пакет enables you to retrieve the number of rows
from a table.

Настройки

Retrieves the number of rows and assigns it to a Number variable. You have the option to select the non-
empty rows or include all the rows in the selection.

Insert column action
The Insert column action in the Таблица данных пакет enables you to insert a column from one table to
another table.

Настройки

For destination table:
• Select the destination table variable form the Enter into data table list.
• Select where to insert the column: first index, last index, or enter the column index number.

Прим.:  The index count starts at 0.
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For source table:
• Select the source table variable from the Insert from table list.
• Enter the name or index number of the column to insert.

Insert row action
The Insert row action in the Таблица данных пакет enables you to insert a row into the table.

Настройки

• In the Data table name field, select the name of the table variable from the drop-down list or create a
new variable of type Table.

• Select where you want to insert the row: first position, last position, or at a specific index
position.

• In the Row record name field, create a record variable or choose an existing record variable to hold
the values for the new row that you want to insert.

• In the Create variable tab, enter the name of the variable and under the Default value section,
enter the name, value, and the type of value that you want to add to the new row as per the specified
index values.

Прим.:  The index count start from 0.

Using Join action
Use the Join action to combine content from two table variables. This action enables you to combine
content based on the shared values of a specific column in the tables and store the content into a third
Table variable or one of the two source tables.
To join the content from two Table variables, do the following:
1. Double-click or drag Data table > Join.
2. Select the first Table variable to use from the Enter first data table name list.
3. Enter the name of the column from the first Table variable that contains the data to join.
4. Select the second Table variable to use from the Enter second data table name list.
5. Enter the name of the column from the second Table variable that contains the data to join.
6. Select an option to specify the type of join. Подробнее см. в разделе Join type output examples.

• inner join: Returns only the records that have matching values in the selected columns in both
tables.

• left outer join: Returns all records from the first table, and the matched records from the second
table.

• right outer join: Returns all records from the second table, and the matched records from the
first table.

• full outer join: Returns all records when there is a match in either left or right table.

7. In the Enter name of data table in which to join field, select the table variable to store the
combined values.

Прим.:
• Starting from Automation 360 v.27 if you are using 4.6.0-20220920-155212 version of the Таблица

данных пакет, the Enter name of data table in which to join field is mandatory and you must
specify a third data table in the field to save the result of the Join action.
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• When you upgrade from a previous version to Automation 360, and if you have not updated the
package version to 4.6.0-20220920-155212, your боты will continue to run as is. In case you
have updated both your боты and the пакет to the latest version, your боты will continue to run
successfully if you have selected a table variable to store the output. If the field is empty, then the
бот will encounter an error.

Join type output examples
Select a join type option based on your desired output. Use the examples below to guide your selection.

Inner join

Returns only the records that have matching values in the selected columns in both tables.
For example, if you have a table of employees and their departments, and a table of employees and their
pay rates, this option will return a table of the employees that exist in both tables, and their departments
and pay rates.
Table 1: Employees and Departments

Employee Отдел

Джон 101

Jill 102

Mike 103

Betty 104

Cindy 105

Table 2: Employees and Pay rates

Employee Pay rate

Джон 50

Betty 50

Mike 40

Jill 35

Dan 45

Table 3: Employees, Departments, and Pay rates

Employee Отдел Pay rate

Джон 101 50

Jill 102 35

Mike 103 40

Betty 104 50
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Left outer join

Returns all records from the first table, and the matched records from the second table.
Using the example Tables 1 and 2, this option returns the following table:
Table 3: Employees, Departments, and Pay rates

Employee Отдел Pay rate

Джон 101 50

Jill 102 35

Mike 103 40

Betty 104 50

Cindy 105

Right outer join

Returns all records from the second table, and the matched records from the first table.
This option returns the following table:
Table 3: Employees, Departments, and Pay rates

Employee Отдел Pay rate

Джон 101 50

Betty 104 50

Mike 103 40

Jill 102 35

Dan 45

Full outer join

Returns all records when there is a match in either left or right table.
This option returns the following table:
Table 3: Employees, Departments, and Pay rates

Employee Отдел Pay rate

Джон 101 50

Jill 102 35

Mike 103 40

Betty 104 50

Cindy 105
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Employee Отдел Pay rate

Dan 45

Using the Merge action
Use the Merge action to combine the contents of two tables when both source tables contain identical
column headers. To combine tables that contain different column headers, use the Join action.
If one of the tables contains non-identical headers, then the merged table will contain the columns from
the first source table with data from the second source table under the identical column headers, followed
by the non-identical columns and data from the second source table.
To merge the content, perform these steps:
1. Double-click or drag Data table > Merge.
2. Select the first table variable you want to use from the Enter first data table name list.
3. Select the second table variable you want to use from the Enter second data table name list.
4. Select the table variable that you want to use to store the merged data from the Enter name of data

table in which to merge list.
5. Щелкните Сохранить.

Подробнее см. в разделе Merge output example.

Merge output example
The Merge action combines data from two tables with identical column headers, and stores the merged
content in a third table or one of the two source tables. These examples demonstrate the output of two
tables with identical column headers and the output of two tables with differing column headers.

Output of tables with identical column headers

For example, if you have a table of employees hired in September and a table of employees that were
hired in October, this option will return a table of all the employees, with the October hires merged below
the September hires.
Table 1: Employees hired in September

Employee Отдел Pay rate

Джон 101 50

Jill 102 35

Table 2: Employees hired in October

Employee Отдел Pay rate

Mike 103 40

Betty 104 50

Table 3: All employees

Прим.:  The column headers in the output table are always lowercase.
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employee department pay rate

Джон 101 50

Jill 102 35

Mike 103 40

Betty 104 50

Output of tables with differing column headers

In this example, the second table has a different column header. As a result, the third table contains the
columns from the first source table with data from the second source table under the identical column
headers, followed by the non-identical columns and data from the second source table.
Table 1: Employees hired in September

Employee Отдел Pay rate

Джон 101 50

Jill 102 35

Table 2: Employees hired in October

Employee Отдел Salary

Mike 103 40

Betty 104 50

Table 3: All employees

employee department pay rate salary

Джон 101 50

Jill 102 35

Mike 103 40

Betty 104 50

Remove duplicate rows action
The Remove duplicate rows action in the Таблица данных пакет enables you to delete any duplicate rows
from a table.

Настройки

Select the Table variable name from the drop-down list.
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Search for a value action
The Search for a value action in the Таблица данных пакет enables you to search for a specific value in
a table and returns the row or column numbers in which the entry occurs and assigns the values to a List
variable.

Настройки

For example, if you search for the entry
abc

that is available at the fourth row and third column of a table variable, the action returns
3,2

as output. As the index number for the row and column starts with zero, the values in the output indicates
the fourth row and third column.
• Select the Table variable name from the drop-down list.
• Enter the text to search for.
• Select Match case to ensure the case matches the text searched.

When you search for a value using the Search for a value action, it will either return:
• A list of all the positions from the Data table where the search matched, or
• An empty list if the value is not found.

Set value of a single cell action
The Set value of a single cell action in the Таблица данных пакет enables you to update the value of a
specific cell.

Настройки

• Select the Table variable name from the drop-down list.
• Enter the row index. For example, to set a value to the first row, enter 0.
• Select whether to specify the column by Name or Index.

• If you select to specify by name, enter the column name. Capitalization is not important.
• If you select to specify by index, enter the column index. For example, to set a value to the first

column, enter 0.

• Введите значение для установки.

Sort action
The Sort action in the Таблица данных пакет enables you to sort the table data by column.

Настройки

This action enables you to sort the data by column data format (string, number, datetime, or Boolean).
• Select the Table variable name from the drop-down list.
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• Specify the column name or column index to sort by.
• Select the order in which to sort: ascending order or descending order.

Прим.:  If you built a  using this  from  version 2.0.0-20200624-042148 or earlier, the  will be missing
when you open the  with the default  version. You must reinsert the  and repopulate the fields.

Использование действия «Записать в файл»
С помощью действия Записать в файл можно записать данные из переменной таблицы в файл CSV
или TXT.
Чтобы записать данные в файл, выполните указанные ниже действия.
1. Дважды щелкните или перетащите Таблица данных > Записать в файл.
2. Выберите переменную таблицы, содержащую данные для записи, из списка Имя таблицы

данных.
3. Укажите местоположение файла, в который будут записаны данные, в поле Введите имя

файла.
4. Установите флажок Создать папки/файлы, если они не существуют, чтобы создать файл

или папку, которые вы указали в поле Введите имя файла.
5. Выберите параметр, определяющий действие при записи данных в существующий файл:

• Добавить в существующий файл
• Заменить существующий файл

6. Выберите параметр из списка Разделитель строк, чтобы указать разделитель, который будет
использоваться для строк.

7. Выберите параметр из списка Разделитель столбцов, чтобы указать разделитель, который
будет использоваться для столбцов.

8. Выберите параметр из списка Кодировка, чтобы указать кодировку для файла.
По умолчанию установлена кодировка ANSI
• ANSI
• UTF-8
• Юникод
• Win1251
• UTF-8 с BOM
• UTF-16LE
• Shift-JIS (японская кодировка)

9. In the Assign value to variable list, select a string variable.

База данных пакет
Базы данных поддерживают внутренние операции предприятия, сохраняя разнообразные данные,
такие как транзакции продаж, каталоги продуктов, складские запасы и профили клиентов. Use the
База данных пакет to connect to a database, begin a transaction, and manipulate the stored data by
retrieving, inserting, updating, deleting, and exporting it to a CSV file.

Перед началом работы

Выполните указанные ниже actions в рамках пакет База данных из числа доступных actions.
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Прим.:  When you use actions such as Read from, Run stored procedure, or Export to data table
to retrieve records from a MS SQL Server table which has a bit type column or an Excel column (with TRUE
or FALSE values), then the retrieved data will be referred to 0 and 1, not TRUE and FALSE.

1. Установите подключение к серверу базы данных с помощью action Подключить.
См. раздел Использование action «Подключить» для базы данных.

2. Выберите один из следующих вариантов:
• Для извлечения записей из базы данных используйте action Прочитать из. См. раздел Using

the Read from action.
• Если вы автоматизируете задачу, которая предполагает внесение изменений в базу

данных, вставьте action Начать транзакцию базы данных, а затем actions которые
автоматизируют изменения.
Это action обеспечивает полное обновление или удаление всех записей и предотвращает
случайное обновление или удаление неполных данных, если во время выполнения бот
возникнет ошибка.

3. Если вы использовали action Начать транзакцию базы данных в этом сеансе, вставьте
Завершить транзакцию базы данных, чтобы зафиксировать изменения.

4. Каждый набор actions базы данных заканчивается action Отключить, чтобы прервать
подключение к серверу базы данных.

Действия в База данных пакет

пакет База данных включает в себя описанные ниже actions.

Действие Описание

Начать транзакцию
базы данных

См. раздел Begin database transaction action.

Завершить
транзакцию базы
данных

См. раздел End database transaction action.

Подключить См. раздел Использование action «Подключить» для базы данных.
База данных Snowflake поддерживается с использованием драйвера
ODBC.

Отключить См. раздел Disconnect action.

Прочитать из См. раздел Using the Read from action.
База данных Snowflake поддерживается с использованием драйвера
ODBC.

Выполнить хранимую
процедуру

См. раздел Using the Run stored procedure action.

Экспортировать в
таблицу данных

См. раздел Using the Export to data table action.
База данных Snowflake поддерживается с использованием драйвера
ODBC.
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Действие Описание

Управление хранимой
процедурой

См. раздел Manage stored procedure action.

Вставить/обновить/удалитьСм. раздел Insert/Update/Delete action.

Ссылки, связанные с данной
Цикл пакет
Use the Цикл package to run a sequence of actions repeatedly for a specific number of times or until a
specific condition is met.
Variables overview
Automation 360 offers a variety of variables, each designed to hold specific types of data and is intended
for specific use. Use the topics below to learn more about each variable and how to use them.

Begin database transaction action
Use the Begin database transaction action in the База данных пакет to starts a database transaction to
commit all database actions till the end database transaction.

Настройки

• actions, которые вы вставляете между actions Начать транзакцию базы данных и Завершить
транзакцию базы данных, обрабатываются как единое целое. бот должен выполнить все
actions успешно, чтобы обновить базу данных. Это предотвращает неполную запись в случае,
если одно из actions завершится со сбоем.
Например, в бухгалтерском учете с двойной записью для каждого дебета требуется запись
кредита. Если компания получает продукты на сумму $5000, бухгалтер должен дебетовать $5000
на складские запасы и кредитовать $5000 на кредиторскую задолженность.

• Вставьте actions, которые вводят эти записи между actions Начать транзакцию базы данных
и Завершить транзакцию базы данных чтобы гарантировать, что либо обе записи будут
введены в базу данных, либо ни одна из них не будет введена.

• In the Session name field, enter the name of the session that you used to connect to the database
server in the Connect action.

Прим.:  Begin and End database transaction actions do not support ODBC connectivity.

End database transaction action
Use the End database transaction action База данных пакет to commits all the database operations that
were performed with the actions that followed the Begin database transaction action.

Настройки

• All the database operations that were performed with the actions that followed the Begin database
transaction action are committed, under the condition that the бот successfully ran those actions.

• In the Session name field, enter the name of the session that you used to connect to the database
server in the Connect action.

Прим.:  Begin and End database transaction actions do not support ODBC connectivity.
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Использование action «Подключить» для базы данных
Используйте action Подключить, чтобы установить соединение с сервером базы данных, который
планируется использовать для автоматизации задач, связанных с базой данных. Это action
поддерживает Microsoft Access, Microsoft SQL Server, MySQL, Oracle, PostgreSQL Server и SQLite, а
также использование файлов CSV, Microsoft Excel и TXT в качестве баз данных.

Прим.:  If your current office installation is any of the following:
• Microsoft 365 Apps for Enterprise
• Office 2016, 2019, or 2021 (Consumer Version 2009 or later)

Then you do not need to install the Microsoft Access Database Engine as an additional component in your
system.
However, if you have both Microsoft 365 Apps and the Microsoft Access Database Engine are installed on
your system, then you can uninstall the Microsoft Access Database Engine and repair Microsoft 365 Apps.
Microsoft recommends that you do not install the Microsoft Access Database Engine driver separately
because both the Microsoft Access Database Engine 2016 and Microsoft 365 Apps use the same major
version identifier (16.0). To learn more about the Microsoft Access Database Engine driver installation
requirement, see Unable to use the Access ODBC or OLEDB provider

Укажите сведения о сервере базы данных и свяжите его с именем сеанса. Используйте имя сеанса,
указанное в этом action, в других actions , чтобы не пришлось указывать сведения о сервере базы
данных в этих actions.
Чтобы установить соединение с сервером базы данных, выполните указанные ниже действия.
1. Дважды щелкните или перетащите action Подключить из пакет База данных на палитре

Действия.
2. Введите уникальное имя сеанса в поле Имя сеанса.
3. Выберите параметр подключения По умолчанию или Определенно пользователем.

When you select User defined connection mode and use actionRead from with encoding ANSI to
save the retrieved data in a CSV file, you will see that the retrieved records from the Oracle database
display garbled character.
To know more about this issue, see Fullwidth hyphen is garbled when exporting data to csv by Database:
Read from action with encoding ANSI (A-people login required)

• Если выбрать параметр По умолчанию, можно напрямую ввести строку подключения для
любого из поддерживаемых типов баз данных.
Если вы настроили базу данных и общий репозиторий на второстепенном
сайте, подключитесь к базе данных реплики с использованием
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подключения JDBC. Например, jdbc:sqlserver://AGL-
ADDRESS:1433;databaseName=DB_NAME;user=username;password=password;applicationIntent=ReadOnly

Можно установить подключение к базе данных Snowflake с помощью драйверов ODBC. Для
получения дополнительной информации о загрузке драйвера ODBC см. Snowflake using ODBC
Driver

Можно ввести строку подключения, чтобы подключиться к базе данных. Например,
Driver={SnowflakeDSIIDriver};Server={account}.aws.snowflakecomputing.com;Database=DB_NAME;uid=username;pwd=password;

Используйте этот параметр для подключения к файлу Excel, CSV или TXT. См. раздел
Connection Strings by database type.

Прим.:  Чтобы получить доступ к любой базе данных с помощью ODBC, необходимо сначала
установить на ваше устройство 32-разрядный драйвер ODBC.

Чтобы обеспечить более безопасную автоматизацию, используйте для строки подключения
переменную Credential Vault.

• Select the Use ODBC 64-bit driver for connection option to connect to the database.

Прим.:
• Ensure that 64-bit access ODBC driver is installed on your system to access any database and

perform operations by using database actions.
• The following action does not support the 32-bit or 64-bit OBDC drivers because the listed

actions are for database transactions that are carried out after making a connection with the
database:
• Begin database transaction
• End database transaction
• Manage stored procedure

• Using Excel as a database, you can process more rows with 64-bit drivers compared to 32-bit
ones.

• Если вы выбрали параметр Определено пользователем, выберите тип базы данных из
доступных вариантов и заполните указанные ниже поля в зависимости от выбора.
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Тип базы данных Параметры

Microsoft SQL Server,
PostgreSQL Server

• Имя сервера. Введите имя сервера
базы данных, к которому требуется
подключиться.

• Имя базы данных. Введите имя базы
данных.

• Имя пользователя. Введите имя
пользователя, которое должно будет
использоваться для доступа к серверу базы
данных. Чтобы обеспечить безопасность
имени пользователя, выберите переменную
Credential Vault. В противном случае введите
значение.

• Пароль. Введите пароль для указанного
вами имени пользователя. Чтобы обеспечить
надежность пароля, выберите переменную
Credential Vault. В противном случае введите
значение.

• Имя экземпляра. Введите имя для этого
экземпляра подключения.

Подключение к Microsoft SQL Server с
использованием аутентификации Windows

MySQL Введите те же параметры, что и для типа базы
данных Microsoft SQL Server. Также введите
номер порта. Номер порта по умолчанию: 3306.

Microsoft Access, SQLite Выберите путь к файлу базы данных:
• Папка Боты
• локальное устройство
• существующая файловая переменная
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Тип базы данных Параметры

Oracle • Server name (Optional): Введите имя
сервера Oracle, к которому требуется
подключиться.

• Optional:Select an option to specify the Oracle
instance you want to use:
• Идентификатор системы (SID).

Введите идентификатор системы.
• Имя службы. Введите имя службы.
• Имя TNS. Введите Имя TNS доступное в

файле конфигурации tnsname.ora.
Укажите путь к файлу tnsname.ora
файла конфигурации, если вы не
установили системное свойство с
переменной окружения.

Прим.:  You can connect to the Oracle
Database with the Server name or Oracle
instance. If you are connecting using
the server name, you must specify the
System id (SID) or Service name in the
Oracle instance field to identify the Oracle
database and its instance. However, if you are
connecting using the TNS name, you do not
require to enter any value in the Server name
field. You should only enter the value of the
TNS name and file path.

• Имя пользователя. Введите имя
пользователя, которое должно будет
использоваться для доступа к серверу
Oracle. Чтобы обеспечить безопасность
имени пользователя, выберите переменную
Credential Vault. В противном случае введите
значение.

• Пароль. Введите пароль для указанного
вами имени пользователя. Чтобы обеспечить
надежность пароля, выберите переменную
Credential Vault. В противном случае введите
значение.

• Порт. Введите номер порта. Номер порта по
умолчанию: 1521.

Прим.:  Если вы устанавливаете подключение с помощью драйвера JDBC, то для Microsoft
SQL Server пакет База данных уже содержит драйвер JDBC. Однако для других серверов баз
данных вы должны указать соответствующий jar-файл драйвера JDBC после его загрузки с
соответствующих ресурсов.
Если вы устанавливаете подключение с помощью драйвера ODBC, указывать jar-файл не
нужно.
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4. Выберите файл драйвера из папки Боты, локального устройства или файловой переменной.
5. Щелкните Сохранить.

Выберите один из следующих вариантов:
• Для извлечения записей из базы данных используйте action Прочитать из.

Using the Read from action
• Если вы автоматизируете задачу, которая предполагает внесение изменений в базу данных,

вставьте action Начать транзакцию базы данных.
Это action обеспечивает полное обновление или удаление всех записей и предотвращает
случайное обновление или удаление неполных данных, если во время выполнения бот возникнет
ошибка.

База данных пакет

Подключение к Microsoft SQL Server с использованием аутентификации Windows
Настройте свое устройство и action «Подключить» из пакет База данных для автоматизации
подключения к Microsoft SQL Server с использованием аутентификации Windows NT.
Эта задачу следует выполнять только для выпусков, предшествующих Сборка 9664. Начиная с
выпуска Сборка 9664, больше не нужно вручную добавлять DLL-файлы для подключения к Microsoft
SQL Server.
Чтобы использовать аутентификацию Windows NT для подключения к Microsoft SQL Server,
выполните указанные ниже действия.
1. Загрузите драйвер JDBC для Microsoft SQL Server.

Download the JDBC Driver from Microsoft

2. В распакованной папке найдите файл .dll в пути к файлу auth\x64\.
3. Если файл .dll имеет другое имя, переименуйте его в sqljdbc_auth.dll.
4. На устройствах Bot Creator или Bot Runner скопируйте файл sqljdbc_auth.dll по одному из

указанных ниже путей, в зависимости от места установки Bot Agent и параметра, выбранного во
время установки.

Прим.:  Если вы используете сборку 9664 или более позднюю, не нужно копировать файл в то
расположение, в которое был установлен Bot Agent.

• Если вы установили Bot Agent на уровне пользователя и выбрали параметр Только для
меня (имя пользователя), скопируйте его в папку C:\Users\<Имя пользователя>
\AppData\Local\Programs\Automation Anywhere\Bot Agent\jre\bin.

• Если вы установили Bot Agent на системном уровне и выбрали параметр Для любого
пользователя этого компьютера (все пользователи), скопируйте в папку C:\Program
 Files\Automation Anywhere\Bot Agent\jre\bin.

Это включит аутентификацию Windows, поскольку драйвер JDBC не может выполнять
аутентификацию по умолчанию.

5. Выберите параметр подключения По умолчанию.
6. Введите строку подключения: jdbc:sqlserver://

localhost;databaseName=Test;integratedSecurity=true;

7. Щелкните Сохранить.

Выберите один из следующих вариантов:
• Для извлечения записей из базы данных используйте action Прочитать из.

Using the Read from action
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• Если вы автоматизируете задачу, которая предполагает внесение изменений в базу данных,
вставьте action Начать транзакцию базы данных.
Это action обеспечивает полное обновление или удаление всех записей и предотвращает
случайное обновление или удаление неполных данных, если во время выполнения бот возникнет
ошибка.

База данных пакет

Disconnect action
Use the Disconnect action in the База данных пакет to disconnect from a database.

Настройки

In the Session name field, enter the name of the session that you used to connect to the database server
in the Connect action.
A record set is returned when you run a stored procedure or a query. To use the record set stored in the
memory even if the session is disconnected, select Keep database schema in cache until bot finishes
running. By using this option, you can enable the Loop action to iterate the record set by using cached
schema after disconnecting from the database.
База данных Snowflake поддерживается с использованием драйвера ODBC.

Using the Read from action
Use the Read from action to retrieve records from the database and save the retrieved data in a CSV file.
This action enables you to retrieve up to one million records from the database.
To automate the task of selecting and saving a set of records, follow these steps:
1. Enter the name of the session you used to connect to the database server in the Connect action.

You do not have to provide the details of the database server here because you have already
associated those details with the session name when using the Connect action.

2. Enter the SELECT statement to specify the column and table names.
This field supports SQL syntax. For example, SELECT CustomerName,City FROM Customers

Прим.:  CTE (Common Table Expression) is supported using WITH keyword in the SQL compliant
databases such as Oracle and MySQL. Например:

WITH customers_in_usa AS (SELECT CustomerName, state FROM customers WHERE
 country = 'USA') 
SELECT cName FROM customers_in_usa WHERE state = 'LA' ORDER BY
 CustomerName

3. Enter the maximum number of records to retrieve.
4. Необязательно: Enter a timeout value.

When the specified time expires, the statement execution stops even if the execution is not
completed.

5. Select the Export data to CSV option to save the retrieved data.
a) Select the file path from the Bots folder, the local device, or an existing file variable.
b) Select the CSV file encoding to be either ANSI, UNICODE, or UTF8.
c) Select whether to export the CSV file with or without the column headers.

With column headers
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CustomerName City

Manny Pittsburgh

Kate Los Angeles

Джон Boston

Without column headers

Manny Pittsburgh

Kate Los Angeles

Джон Boston

d) Select this check box if you do not want a CSV file to be created when the SQL query does not
return any data.

e) Specify whether to overwrite the file or append the data to the existing file if a CSV file with the
same name exists.

6. Щелкните Сохранить.

Using the Run stored procedure action
Stored procedures are a set of SQL statements that are created and stored in the database. These SQL
statements might be complex and have to run multiple times. Use the Run stored procedure action to
execute existing stored procedures.

Прим.:
• This action does not support Microsoft Access or SQLite database types.
• Starting from Automation 360 v.22 (Сборка 10526), for stored procedures, the limit of 32 characters for

input and output parameters has been removed.

To automate the task of executing a stored procedure, follow these steps:
1. Enter the name of the session you used to connect to the database server in the Connect action.

You do not have to provide the details of the database server here because you have already
associated those details with the session name when using the Connect action.

2. Enter the name of the stored procedure.
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3. Необязательно: Click Add parameter to provide an input parameter or configure an output
parameter.
Select from the following parameter options:
Вариант Шаги

Ввод Parameter is passed from the бот to the stored procedure.
• Name: Enter the name of the parameter from the stored procedure.
• Value (optional): Enter a value or select a variable.
• Тип: Select the data type from the following options

• BIGINT (number)
• BINARY (Boolean)
• BIT (number)
• CHAR (string)
• DATE (date time)

Supported format yyyy-mm-dd
• DECIMAL (number)
• DOUBLE (number)

Default choice for decimal values.
• FLOAT (number)
• INTEGER (number)

Uses 4 bytes to store an integer with a value from -2,147,483,648 to
2,147,483,647

• LONGVARBINARY (Boolean)
• LONGVARCHAR (string)
• NUMERIC (number)
• REAL (number)
• SMALLINT (number)

Uses 2 bytes to store an integer with a value from -32,768 to 32,767
• TIME (date time)

Supported format hh:mm:ss
• TIMESTAMP (date time)

Supported format yyyy-mm-dd hh:mm:ss.f, where f is fractional
seconds

• TINYINT (number)
Uses 1 byte to store an integer with a value from 0 to 255

• VARBINARY (Boolean)
• VARCHAR (string)

For example, if running the example function from the Manage stored
procedure action, configure the following two input parameters and values
for the sum_of_two function to add:
• Parameter 1: num1, 5, TINYINT
• Parameter 2: num2, 10, TINYINT
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Вариант Шаги

Выходной Parameter is passed from the stored procedure to the бот.
• Name: Enter the name of the parameter from the stored procedure.
• Тип: Select the data type from the following options

• BIGINT (number)
• BINARY (Boolean)
• BIT (number)
• CHAR (string)
• DATE (date time)

Supported format yyyy-mm-dd
• DECIMAL (number)
• DOUBLE (number)

Default choice for decimal values.
• FLOAT (number)
• INTEGER (number)

Uses 4 bytes to store an integer with a value from -2,147,483,648 to
2,147,483,647

• LONGVARBINARY (Boolean)
• LONGVARCHAR (string)
• NUMERIC (number)
• REAL (number)
• SMALLINT (number)

Uses 2 bytes to store an integer with a value from -32,768 to 32,767
• TIME (date time)

Supported format hh:mm:ss
• TIMESTAMP (date time)

Supported format yyyy-mm-dd hh:mm:ss.f, where f is fractional
seconds

• TINYINT (number)
Uses 1 byte to store an integer with a value from 0 to 255

• VARBINARY (Boolean)
• VARCHAR (string)

When the бот runs, the action converts the database data type to an
Automation 360-supported data type.
For example, if running the example sum_of_two function from the
Manage stored procedure action, configure the output parameter: sum,
TINYINT.
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Вариант Шаги

ВходнойВыходной Parameter can be used for both input and output.
• Name: Enter the name of the parameter from the stored procedure.
• Value (optional): Enter a value or select a variable.
• Тип: Select the data type from the following options

• BIGINT (number)
• BINARY (Boolean)
• BIT (number)
• CHAR (string)
• DATE (date time)

Supported format yyyy-mm-dd
• DECIMAL (number)
• DOUBLE (number)

Default choice for decimal values.
• FLOAT (number)
• INTEGER (number)

Uses 4 bytes to store an integer with a value from -2,147,483,648 to
2,147,483,647

• LONGVARBINARY (Boolean)
• LONGVARCHAR (string)
• NUMERIC (number)
• REAL (number)
• SMALLINT (number)

Uses 2 bytes to store an integer with a value from -32,768 to 32,767
• TIME (date time)

Supported format hh:mm:ss
• TIMESTAMP (date time)

Supported format yyyy-mm-dd hh:mm:ss.f, where f is fractional
seconds

• TINYINT (number)
Uses 1 byte to store an integer with a value from 0 to 255

• VARBINARY (Boolean)
• VARCHAR (string)

4. Enter the maximum number of records to retrieve.
You can limit the results of the execution.

5. Необязательно: Enter a timeout value.
When the specified time expires, the statement execution stops even if the execution is not
completed.
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6. Необязательно: Select the Export data to CSV option to save the retrieved data.

Прим.:  The Export data to CSV option does not support Oracle Database or PostgreSQL Server
database types. Use output parameters to retrieve values.

a) Select the file path from the Bots folder, the local device, or an existing file variable.
b) Select the CSV file encoding to be either ANSI, UNICODE, or UTF8.
c) Select whether to export the CSV file with or without the column headers.

With column headers

CustomerName City

Manny Pittsburgh

Kate Los Angeles

Джон Boston

Without column headers

Manny Pittsburgh

Kate Los Angeles

Джон Boston

d) Specify whether to overwrite the file or append the data to the existing file if a CSV file with the
same name exists.

7. Необязательно: Select a dictionary variable to hold the output if the stored procedure returns a value.
Each output parameter name is a dictionary key which holds the corresponding parameter value.
For example, if you assign the sum_of_two function output to $Output$, when the бот calls
$Output{sum}$, the variable returns 15.

Прим.:  If you do not know the output parameter name, use the default key Output appended by
the parameter index number.

8. Щелкните Сохранить.

Using the Export to data table action
Use the Export to data table action to retrieve records from the database and store the retrieved data in
a table variable.
To automate the task of selecting and saving a set of records, follow these steps:
1. Enter the name of the session you used to connect to the database server in the Connect action.

You do not have to provide the details of the database server here because you have already
associated those details with the session name when using the Connect action.

2. Enter the SELECT statement to specify the column and table names.
This field supports SQL syntax. For example, SELECT CustomerName,City FROM Customers

Прим.:  CTE (Common Table Expression) is supported using WITH keyword in the SQL compliant
databases. For example, WITH customers_in_usa AS (SELECT CustomerName, state FROM
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 customers WHERE country = 'USA') SELECT cName FROM customers_in_usa WHERE
 state = 'LA' ORDER BY CustomerName

3. Enter the maximum number of records to retrieve.
4. Необязательно: Enter a timeout value.

When the specified time expires, the statement execution stops even if the execution is not
completed.

5. In the Assign to option, select the table variable to store the retrieved data.
6. Щелкните Сохранить.

Manage stored procedure action
Use the Manage stored procedure action in the База данных пакет to create, update, and delete a stored
procedure within the specified database. Хранимая процедура — это SQL-код, сохраненный в базе
данных, позволяющий запускать его многократно.

Настройки

• In the Session name field, enter the name of the session that you used to connect to the database
server in the Connect action.

• В поле Введите полную команду введите команду для создания, обновления или удаления
хранимой процедуры. Вы можете указать входные и выходные параметры для команды; вы
указываете значения или переменные, содержащие значения в action Выполнить хранимую
процедуру.

Прим.:  Объявите разделитель и используйте его для закрытия инструкции SQL.

Пример MySQL. В данном примере бот проверяет, существует ли в базе данных процедура
с именем sum_of_two. Если нет, то бот создает процедуру, которая принимает два входных
параметра (num1 и num2), складывает их вместе и выдает сумму в качестве выходного
параметра:

 DROP PROCEDURE IF EXISTS sum_of_two;
    DELIMITER $$
        CREATE PROCEDURE sum_of_two(IN num1 INT,IN num2 INT,OUT sum INT)
        BEGIN
            SET sum := num1 + num2;
    END
    $$

• В поле Время ожидания запроса в секундах укажите время, в течение которого выполнение
инструкции должно быть остановлено, даже если выполнение не завершено.

Insert/Update/Delete action
Use the Insert/Update/Delete action in the База данных пакет to execute an INSERT, UPDATE, or DELETE
statement from the database.

Настройки

• In the Session name field, enter the name of the session that you used to connect to the database
server in the Connect action.
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• В поле Инструкция введите оператор SQL для вставки, обновления или удаления записей.
• Для создания новых записей в таблице используйте инструкцию INSERT:

INSERT INTO table_name (column1, column2, column3, ...)
VALUES (value1, value2, value3, ...)

• Для изменения записи используйте инструкцию UPDATE:

UPDATE table_name
SET column1 = value1, column2 = value2, ...
WHERE condition

• Для удаления записи используйте инструкцию DELETE:

DELETE FROM table_name WHERE condition
Example: DELETE FROM Persons WHERE LastName='Smith'

• В поле Время ожидания запроса в секундах укажите время, в течение которого выполнение
инструкции должно быть остановлено, даже если выполнение не завершено.

Пример переноса данных из Excel в базу данных
В этом примере вы создаете бот для передачи значений из таблицы Excel в базу данных с
использованием actions из пакеты База данных, Расширенный Excel и Цикл.
Прежде чем приступить к формированию бот, создайте следующее:
• Создайте таблицу Excel со следующими значениями и сохраните ее (например:

Test_migration_db.xlsx)

Джон Уильямс (John
Williams)

jwilliams@cmail.com

Сэм Ли (Sam Li) sam.li@xyz.org

Карл Миллер (Carl
Miller)

carl@carlmillerllc.com

• Создайте таблицу базы данных Access с именем CustomerT со следующими столбцами:
(создайте базу данных, подобную изображенной ниже, и сохраните ее, например, как
Test_Migration_db.accdb)
• Имя
• Фамилия
• Эл. почта
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Чтобы перенести значения из электронной таблицы в таблицу базы данных, выполните указанные
ниже действия.
1. Create a new бот:

a) На левой панели щелкните Автоматизация.
b) Щелкните Создать > Бот.
c) In the Create Task Bot window, enter the бот name.
d) Accept the default folder location: \Bots\

To change the default бот storage location, click Choose and follow the prompts.
e) Щелкните Создать и редактировать.

2. Откройте электронную таблицу:
a) Дважды щелкните или перетащите action Расширенный Excel > Открыть.
b) Щелкните Обзор, чтобы указать путь к файлу.

c) Выберите вариант открытия файла в режиме Чтения и записи.
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3. Подключитесь к базе данных:
a) Дважды щелкните или перетащите action База данных > Подключить.
b) Выберите режим подключения Определено пользователем.

c) Выберите тип базы данных Microsoft Access.
d) Щелкните Обзор, чтобы указать путь к файлу.

© 2023 Automation Anywhere. All rights reserved.     1480



    Automation Anywhere - Сборка

4. Вставьте значения Excel в базу данных, строка за строкой:
a) Дважды щелкните или перетащите action Цикл.
b) Выберите итератор Расширенный Excel > Для каждой строки на листе.
c) Выберите Все строки в раскрывающемся списке Цикл до.

d) В поле «Присвоить текущее значение этой переменной» создайте переменную записи
rExcelCurrentRow.

e) Перетащите action База данных > Вставить/обновить/удалить в контейнер «Цикл».
f) Введите следующую инструкцию SQL:

INSERT INTO CustomerT (FirstName,LastName,Email) values
 ('$rExcelCurrentRow[0]$','$rExcelCurrentRow[1]$','$rExcelCurrentRow[2]$');
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5. Отключитесь от базы данных. Перетащите action База данных > Отключить в область ниже
контейнера «Цикл».

6. Закройте электронную таблицу. Дважды щелкните или перетащите action Расширенный Excel
> Закрыть электронную таблицу.

7. Щелкните Сохранить.

Ссылки, связанные с данной
База данных пакет
Базы данных поддерживают внутренние операции предприятия, сохраняя разнообразные данные,
такие как транзакции продаж, каталоги продуктов, складские запасы и профили клиентов. Use the
База данных пакет to connect to a database, begin a transaction, and manipulate the stored data by
retrieving, inserting, updating, deleting, and exporting it to a CSV file.
Расширенный Excel пакет
The Расширенный Excel пакет contains actions that enable you to automate many of the repetitive tasks
when working with Microsoft Excel spreadsheets.
Цикл пакет
Use the Цикл package to run a sequence of actions repeatedly for a specific number of times or until a
specific condition is met.

© 2023 Automation Anywhere. All rights reserved.     1482



    Automation Anywhere - Сборка

Database server support matrix
Refer to the list of databases supported in Automation 360
Following is the list of supported database server with JDBC connectivity.

Database
action

MS SQL
server

MS
access

PostgreSQL
Server

My SQL Excel Текст CSV Oracle AWS
RDS

Microsoft
Azure

ПодключитьY Y Y Y N N N Y Y Y

ОтключитьY Y Y Y N N N Y Y Y

Прочитать
из

Y Y Y Y N N N Y Y Y

Выполнить
хранимую
процедуру

Y н/д Y Y н/д н/д н/д Y Y Y

Экспортировать
в
таблицу
данных

Y Y Y Y N N N Y Y Y

Managed
stored
procedure

Y н/д Y Y н/д н/д н/д Y Y Y

Insert/
Update /
Delete

Y Y Y Y N N N Y Y Y

Начать
транзакцию
базы
данных

Y н/д Y Y н/д н/д н/д Y Y Y

Завершить
транзакцию
базы
данных

Y н/д Y Y н/д н/д н/д Y Y Y

Following is the list of supported database server with ODBC connectivity.

Database
action

MS
SQL
server

MS
access

PostgreSQL
Server

My
SQL

Excel Текст CSV SnowflakeOracle AWS
RDS

Microsoft
Azure

ПодключитьY Y Y Y Y Y Y Y Y Y Y

ОтключитьY Y Y Y Y Y Y Y Y Y Y

Прочитать
из

Y Y Y Y Y Y Y Y Y Y Y

Выполнить
хранимую
процедуру

Y н/д Y Y н/д н/д н/д н/д Y Y Y
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Database
action

MS
SQL
server

MS
access

PostgreSQL
Server

My
SQL

Excel Текст CSV SnowflakeOracle AWS
RDS

Microsoft
Azure

Экспортировать
в
таблицу
данных

Y Y Y Y N N N - Y Y Y

Managed
stored
procedure

N н/д N N н/д н/д н/д н/д N N N

Insert/
Update /
Delete

Y Y Y Y Y Y Y Y Y Y Y

Начать
транзакцию
базы
данных

N н/д N N н/д н/д н/д N N N N

Завершить
транзакцию
базы
данных

N н/д N N н/д н/д н/д N N N N

• Y: Supported
• N: Not supported
• n/a: Не применимо

Datetime пакет
A datetime value consists of a date, time, and time zone. Рабочая область RPA stores datetime values in a
Datetime variable. The Datetime пакет contains actions that enable you to perform various operations on
datetime values. You can use these actions to manipulate and compare values in the Datetime variables.

Действия in the Datetime пакет

You can enter either a String or a Global variable for any of the actions in the Дата/время package. The
actions then assign the output to a variable.
The actions in the Datetime пакет accept a variable as an input and assign the output to a variable.
These actions enable you to compare two Datetime values, add to or subtract from a Datetime value, and
convert a Datetime value to a string value.
The Datetime пакет includes the following actions:

Действие Описание

Добавить См. раздел Using the Add action.

Присвоить См. раздел Использование действия
«Присвоить».

После См. раздел Is after action in Дата/время.
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Действие Описание

До См. раздел Is before action in Дата/время.

Равно См. раздел Is equal action in Дата/время.

Вычесть См. раздел Using the Subtract action.

В строку См. раздел Using the To string action.

Ссылки, связанные с данной
Datetime formats
Specify a custom format when you convert a datetime value to a string value by using the predefined
formats available in Рабочая область RPA.

Using the Add action
Use the Add action to increase the value in the Datetime variable by a specified time value and unit. For
example, you can use this action to increase the Datetime variable value by three hours or by three days.

To add a value to a Datetime variable, do the following:
1. Double-click or drag the Add action from the Datetime node in the Actions palette.
2. Select an option from the Source date and time variable list to specify the variable that contains

the value to which you want to add the time unit.
3. Enter the value you want to add in the Time value to add field.
4. Select an option from the Time unit to add list to specify the time unit you want to add.

Choose from the following time unit options:
• Миллисекунды
• Секунды
• Минуты
• Часы
• Дни
• Недели
• Месяцы
• Годы

Прим.:  This action accounts for leap years. For example, if the action adds 28 days to February
1, 2020, the action output is February 29, 2020. Whereas, if the action adds 28 days to February 1,
2019, the action output is March 1, 2019.

5. Select the Datetime variable from the Assign the output to a variable list to specify the variable to
which you want to assign the output.

6. Щелкните Сохранить.

To see the output value, convert the value in the Datetime variable to a String variable, then print the
value with the Message Box action. Для получения дополнительной информации см. Using the To
string action и Using the Message box action.

Использование действия «Присвоить»
Use the Assign action to assign a String variable with a selected datetime format, assign a datetime value
manually, or assign an existing Datetime variable into a Datetime variable.
Чтобы присвоить переменной «Дата/время» значения, выполните следующие действия.
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1. Дважды щелкните или перетащите action В строку из узла Дата/время на палитру Действия.
2. Выберите опцию Введите дату/время или Переменная.

• Если вы выбрали Введите дату/время, выполните следующие действия.
a. Введите значения даты и времени или выберите строковую переменную.

Прим.:  Чтобы ввести несколько переменных, разделите их одинарными кавычками. For
example, to input the variables date1 and time1, enter the following: 'date1"time1'

b. Выберите формат даты/времени.
Выберите один из готовых форматов или задайте собственный формат. Подробнее о
готовых форматах: Datetime formats.

• Если вы выбрали Переменная, выберите либо опцию Дата/время или Переменная.
• Используйте опцию Дата/время, если хотите выбрать дату, время и часовой пояс

вручную.
• Используйте опцию Переменная, если хотите выбрать переменную Дата/время или

другие переменные, которые могут иметь Дата/время в качестве подтипа, например
«Словарь», «Запись» и «Список».

3. Выберите переменную, которая будет использоваться для хранения вывода из списка
Переменная целевых даты и времени.

4. Щелкните Сохранить.

Is after action in Дата/время
The Is after action in the Дата/время пакет compares two Datetime variables and verifies if the value
of the source variable is after the value available in the comparison variable, and stores the output to a
Boolean variable.

Настройки

• From the Source date and time variable section, select either the Datetime or Variable option.
Use the Datetime option to enter the date and time. Use the Variable option to select the global
value.

• Select the source variable from the Source date and time variable list, and select the variable you
want to compare with from the Date and time variable to be compared to list.

• Select the Datetime variable from the Assign the output to a variable list to specify the variable you
want to use to assign the output.
For example, if the value in the source variable is after the value in the comparison variable, the system
stores True as the output in the Boolean variable. If the value in the source variable is not after the
value in the comparison variable, the system stores False as the output in the Boolean variable.

Is before action in Дата/время
The Is before action in the Дата/время пакет compares two Datetime variables and verifies if the value
of source variable is before the value available in the comparison variable, and stores the output to a
Boolean variable.
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Настройки

• Select the source variable from the Source date and time variable list, and select the variable you
want to compare with from the Date and time variable to be compared to list.

• Select the Datetime variable from the Assign the output to a variable list to specify the variable you
want to use to assign the output.
For example, if the value in the source variable is before the value in the comparison variable, the
system stores True as the output in the Boolean variable. If the value in the source variable is not
before the value in the comparison variable, the system stores False as the output in the Boolean
variable.

Is equal action in Дата/время
The Is equal action in the Дата/время пакет compares two Datetime variables and verifies if the value
of the source variable is equal to the value available in the comparison variable, and stores the output to a
Boolean variable.

Настройки

• Select the source variable from the Source date and time variable list, and select the variable you
want to compare with from the Date and time variable to be compared to list.

• Select the Datetime variable from the Assign the output to a variable list to specify the variable you
want to use to assign the output.
For example, if the value in the source variable is equal to the value in the comparison variable, the
system stores True as the output in the Boolean variable. If the value in the source variable is not
equal to the value in the comparison variable, the system stores False as the output in the Boolean
variable.

Using the Subtract action
Use the Subtract action to decrease the value in the Datetime variable by a specified time value and unit.
For example, you can use this action to decrease the Datetime variable value by three hours or by three
days.
To subtract a value from a Datetime variable, do the following:
1. Double-click or drag the Subtract action from the Datetime node in the Actions palette.
2. Select an option from the Source date and time variable list to specify the variable that contains

the value from which you want to subtract the time unit.
3. Enter the value you want to subtract in the Time value to subtract field.
4. Select an option from the Time unit to subtract list to specify the time unit you want to subtract.

Choose from the following time unit options:
• Миллисекунды
• Секунды
• Минуты
• Часы
• Дни
• Недели
• Месяцы
• Годы
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Прим.:  This action accounts for leap years. For example, if the action subtracts 31 days from March
31, 2020, the action output is February 29, 2020. Whereas, if the action subtracts 31 days from March
31, 2019, the action output is February 28, 2019.

5. Select the Datetime variable from the Assign the output to a variable list to specify the variable to
which you want to assign the output.

6. Щелкните Сохранить.

To see the output value, convert the value in the Datetime variable to a String variable, then print the
value with the Message Box action. Для получения дополнительной информации см. Using the To
string action и Using the Message box action.

Using the To string action
Use the To string action to convert a datetime value to a string value. This action enables you to select a
predefined format or specify a custom format for the output value.
You can select a predefined format for datetime or provide a custom format based on your requirements.
См. раздел Datetime formats.
To convert a datetime value to string, do the following:
1. Double-click or drag the To string action from the Datetime node in the Actions palette.
2. Select an option from the Source date and time variable list to specify the variable that contains

the datetime value that you want to convert to a string value.
3. Select an option from the Formats list to specify the predefined format in which you want to store

the string value.
4. Select the Custom format to specify a custom format based on your requirement.

Datetime formats

5. Select the string variable that you want to use to store the converted value from the Assign the
output to a variable list.

6. Щелкните Сохранить.

Datetime formats
Specify a custom format when you convert a datetime value to a string value by using the predefined
formats available in Рабочая область RPA.
Действие В строку позволяет преобразовать значение даты/времени в строковое значение.
Это действие также позволяет выбрать предопределенный формат даты/времени или указать
пользовательский формат.

Предопределенный формат даты/времени

Когда вы конвертируете значение даты/времени в строковое значение, предопределенные форматы
даты/времени доступны в списке Форматы. Доступны следующие предопределенные форматы
даты/времени:
• BASIC_ISO_DATE: Converts the datetime value to a yyyymmdd+offset value string value.
• ISO_LOCAL_DATE: Converts the datetime value to a yyyy-mm-dd string value.
• ISO_OFFSET_DATE: Converts the datetime value to a yyyy-mm-dd+offset value string value.

Значение смещения указывает на разницу между местным временем и UTC в часах и минутах.
• ISO_DATE: Converts the datetime value to a yyyy-mm-dd+offset value or yyyy-mm-dd string

value. Система добавляет значение смещения, если оно доступно.
• ISO_LOCAL_TIME: Converts the datetime value to a hh:mm:ss.SSS string value.
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• ISO_OFFSET_TIME: Converts the datetime value to a hh:mm:ss.SSS+offset value string value.
Значение смещения указывает на разницу между местным временем и UTC в часах и минутах.

• ISO_TIME: Converts the datetime value to a hh:mm:ss.SSS, or hh:mm:ss.SSS+offset value
string value. Значение смещения указывает на разницу между местным временем и UTC в часах и
минутах.

• ISO_LOCAL_DATE_TIME: Converts the datetime value to a yyyy-mm-ddThh:mm:ss.SSS string
value.

• ISO_OFFSET_DATE_TIME: Converts the datetime value to a yyyy-mm-ddThh:mm:ss.SSS
+offset value string value. Значение смещения указывает на разницу между местным временем
и UTC в часах и минутах.

• ISO_ZONED_DATE_TIME: Converts the datetime value to a yyyy-mm-ddThh:mm:ss.SSS
+offset value[zone id] string value. Значение смещения указывает на разницу между
местным временем и UTC в часах и минутах. The 'zone id' in the format represents the time zone.

• ISO_DATE_TIME: Converts the datetime value to a yyyy-mm-ddThh:mm:ss.SSS, yyyy-mm-
ddThh:mm:ss.SSS+offset value, or yyyy-mm-ddThh:mm:ss.SSS+offset value[zone id]
string value.

• ISO_ORDINAL_DATE: Converts the datetime value to a yyyy-[day of the year], or yyyy-
[day of the year]+offset value string value. Например, если значение даты/времени
«25 января 2018 года», оно будет отформатировано как «2018-25», где «25» указывает на день
года.

• ISO_WEEK_DATE: Converts the datetime value to a yyyy-[week of the year]-[day of the
 week], or yyyy-[week of the year]-[day of the week]+offset value string value.
Например, если значение даты/времени «25 января 2018 года», оно будет отформатировано как
«2018-Н4-4», где «Н4» означает, что это четвертая неделя года, а «4» — день этой недели.

• ISO_INSTANT: Converts the datetime value to a yyyy-mm-ddThh:mm:ss.SSSZ string value.
• RFC_1123_DATE_TIME: Converts the datetime value to a [day of the week], [day of

 the month] [month in 'MMM' format] [year in 'YYYY' format] hh:mm:ss, or [day
 of the week], [day of the month] [month in 'MMM' format] [year in 'YYYY'
 format] hh:mm:ss+offset value string value. Например, если значение даты/времени
«2018-01-25 10:15», оно будет отформатировано как «Вт, 25 декабря 2018 10:15:00 GMT». «GMT»
указывает на отсутствие доступного смещения.

Пользовательский формат даты/времени

Используйте предопределенные соглашения, чтобы указать пользовательский формат
даты/времени. Доступны следующие соглашения:

Прим.:  All predefined conventions that are used to specify a custom datetime format are case-sensitive.

• 'y' and 'Y': Specify a year as 'yy' or 'yyyy' and specify the year of the week as 'YY' respectively.

Прим.:  The ‘yy’ and ‘YY’ provide the same result, however the result differs if you use a datetime
format that includes the last week or the first week of a calendar year.
For example, when you use a datetime format as 12/26/22 (2022/12/26), then perform actions to
delete the files from the previous year, the datetime format ‘yy’ provides correct result (12/26/21) and
the files from the year 2021 are deleted. If you use the datetime format ‘YY’ (indicating the year of the
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week in which the specific day appears), then files from the year 2022 will be deleted because the day
12/26/21 falls during the last week of 2021 and also during the first week of 2022.

We recommend that you use the datetime format 'yy' when you want to consider the calendar year only
and not a specific week of that calendar year.

• «M». Укажите месяц в формате «М», «ММ», «МММ» (сокращенное название месяца, например,
янв, фев) или «ММММ» (полное название месяца, например, январь, февраль).

Прим.:  The 'MMM' and 'MMMM' datetime formats work depending on the operating system on which
the Bot Agent runs and your location setting.

• «д». Укажите день в формате «д» или «дд».
• «Д». Укажите день в году в формате «Д» или «ДД».
• «E». Укажите день недели в формате «EEE» (вс-сб) или «EEEE» (воскресенье-суббота).

Прим.:  The 'EEE' and 'EEEE' datetime formats work depending on the operating system on which the
Bot Agent runs and your location setting.

• «ч» или «Ч». Укажите час в формате «чч» или «ЧЧ».

Прим.:  HH is a 24-hour time format, and hh is a 12-hour time format with AM or PM. When you
use the hh format, add a at the end of the datetime format. For example, if the system locale
language is English, the input will be 2018-12-25 10:50:55.999 AM and the format will be yyyy-
MM-dd hh:mm:ss.SSS a where a indicates AM or PM. However, on computers that use operating
systems in languages other than English, use AM or PM marker accordingly. For example, on a
Japanese language operating system, the input must have AM or PM marker in Japanese, such as
2018-12-25 10:50:55.999 午前, where 午前 means AM in Japanese, and the format must be yyyy-MM-
dd hh:mm:ss.SSS a.

• «а». Укажите маркер AM/PM для 12-часового формата времени.
• «м». Укажите минуту в часе в формате «мм».
• «с». Укажите секунду в минуте в формате «сс».
• «С». Укажите миллисекунду в формате «ССС».
• «п». Укажите часовой пояс, например «Тихоокеанское время» или «Индийское стандартное

время».
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• «П» Укажите время смещения для часового пояса, например, «+0550» для «Индийского
стандартного времени».

Important:  On computers where the display language is set to Simplified Chinese or Traditional Chinese,
when you use the dd-MMM-yyyy custom datetime format to convert a datetime value to a string value, the
output might show incorrectly.

Вы можете использовать предыдущее соглашение, чтобы указать пользовательский формат,
который вы хотите использовать для преобразования значения даты/времени. Ниже приведены
примеры, в которых используется предыдущее соглашение:

Формат Образец выходных данных

гггг-ММ-дд 2018-9-30

гггг-М-д 2020-9-08

дд-MM-гггг 25-12-2018

гггг-ММ-дд ЧЧ:мм:сс 2018-25-12 23:50:55

чч:мм:сс.ССС a 10:15:35.889 AM / 10:15:35.889 PM

гггг-ММ-дд ЧЧ:мм:сс.ССС 2018-12-25 23:50:55.999

гггг-ММ-дд ЧЧ:мм:сс.ССС П 2018-12-25 23:50:55.999 +0530

ч.мм a 4.10 PM

Д «дней», гггг 365 дней, 2019

Задержка пакет
Use the Задержка пакет to add a timed delay to the logic.
You can use timed delay to add the amount of time a бот waits before moving to the next task. You can
specify the amount of time in milliseconds or seconds.

Прим.:  You can specify a maximum time delay of 9999999 milliseconds or seconds.

Пример. If we give a timed delay of 5 seconds, the бот will wait for 5 seconds and then execute the action
following the delay.
пакет Задержка включает в себя указанные ниже action.

Действие Описание

Задержка См. раздел Delay action in Задержка.

Delay action in Задержка
Use the Delay action in the Задержка пакет to add a timed delay.

Настройки

• Select the Delay type as Regular or Random.
• Select the Regular option to delay the operation for a fixed period of time.
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• If you select Random, specify the time range in the From and To fields for the system to select a
random delay within the specified range.
You can add Random delay with different waiting time for each бот run at a given command level
without having to change the бот.
Пример. Use Random delay when running боты simultaneously on several machines through a
workload management queue before executing a database or recorder, or the FTP action. This would
reduce the number of concurrent requests made to a database or the FTP server and the performance
of the systems will not be adversely impacted.

• Select the Time unit in Milliseconds or Seconds.

Dictionary пакет
The Dictionary пакет contains actions that enable you to do various operations on dictionary-type values.

Dictionary data type

A dictionary is a collection of key-value pairs, in which each key has a value. It is similar to an entry in a
dictionary, where each word has a corresponding definition or explanation. The key is similar to the word,
and the definition or explanation is similar to its value. The properties of dictionary entries are as follows:
• Keys are unique within each dictionary variable. If you try to duplicate a key, you will overwrite its

value.
• Key names cannot be changed.
• Keys are case-sensitive.
• Keys can contain leading and trailing whitespaces.

Each key-value pair in a dictionary is separated by a colon. The key-value pairs are separated from each
other by commas. An example of a dictionary is as follows:

invoice = {'CustomerID': 9876, 'Location': 'XYZ', 'Amount': 12,34,567}

In the example, 'CustomerID', 'Location', and 'Amount' are keys, and the corresponding value assigned to
each key is separated by a colon.

Working with variables of dictionary data type

A dictionary variable can hold values of boolean, number, or string data subtype. When initializing a
dictionary variable, you can select the Any data subtype in order to hold any of the three data subtypes.
You can manually enter values by creating a new variable or selecting an existing one from the Variables
menu, and then clicking Add.
Use a dictionary variable to hold email or PDF properties.

Прим.:  When you use either the dictionary variable or the Get action from the Словарь пакет to verify
whether a key exists in a dictionary variable and retrieve its corresponding value, different output displays
if the key does not exist:
• The dictionary variable retrieves a null value.
• The Get action retrieves a blank value.
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Действия in the Dictionary пакет

The following actions are available:

Действие Описание

Assign См. раздел Assign action in Словарь.

Get См. раздел Get action in Словарь.

Put См. раздел Put action in Словарь.

Remove См. раздел Remove action in Словарь.

Size См. раздел Size action in Словарь.

Задачи, связанные с данной
Example of passing a value between боты
Learn how to pass a value from one TaskBot to another by using a dictionary variable.

Assign action in Словарь
Use the Assign action in the Словарь пакет to assign the value of the source dictionary to the destination
dictionary variable.

Настройки

• Select the source dictionary variable from the drop-down list or create a new dictionary variable.
• Select a variable or create one to hold the output.

Get action in Словарь
Use the Get action in the Словарь пакет to verify if a key exists in a dictionary variable and return the
corresponding value.

Настройки

• Select the dictionary variable from the drop-down list.
• Enter the key name.
• Select a dictionary variable or create one to hold the output.

Put action in Словарь
Use the Put action in the Словарь пакет to assign a value to a key in the dictionary. If the key is already
associated with a value, the value can be updated.

Настройки

• Select the dictionary variable from the drop-down list.
• Enter the key name.
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• Assign a value to the key.
You can choose the Static value tab to add the values manually or the Variable tab to add the
existing variables.

Прим.:  If you choose the Static value option, ensure that the data type of static value matches the
subtype of the dictionary variable. Otherwise, you might encounter type cast errors when you use the
dictionary variables.

• Select the variable to hold the previous value.

Remove action in Словарь
Use the Remove action in the Словарь пакет to remove a value from the specified key. The removed
value is assigned to a variable selected from the Assign removed item to variable list.

Настройки

• Select the dictionary variable from the drop-down list.
• Enter the key name.
• Select the variable to hold the removed value.

Size action in Словарь
Use the Size action in the Словарь пакет to retrieve the number of entries in the dictionary.

Настройки

Retrieves the number of entries in the dictionary specified in the Dictionary variable field and assigns
the output to a number variable selected from the Assign the output to variable list.

DLL пакет
A dynamic-link library (DLL) file contains a shared library of functions that can be used by Windows
programs. The DLL пакет uses a .dll file as reference and calls functions from the бот.

Перед началом работы

Perform the following actions within the DLL пакет as part of using the set of available actions:

Прим.:
• If you create боты using custom DLL, and the custom DLL has a dependency on the Apache log4net

library, then we recommend using:
• log4net version 2.0.11 or later in the custom DLL.
• Update the Bot Agent (version 21.210 or later) even if the Bot Agent update is optional.

• Only the DLLs built using the Microsoft .NET Framework are supported.
• The Run DLL пакет is compatible with the following versions of Microsoft .NET: 4.6, 4.7, and 4.8.
• When you create a бот and use the local session with loop, ensure that you use the close session

action in the бот. If you do not use the close session command, then the local session will open
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AutomationAnywhere.ManagedDLLWrapper.exe with each iteration of the loop. As a result, you
will run out of memory space and the бот will fail.

Important:  If you use different versions of the DLL пакет in a parent бот and a child бот, the capability
to share a session across боты is currently not supported. To share a session across parent and child боты,
ensure that you use the same version of the package in both the parent and child боты.

1. Use the Open action to specify the location of the .dll file you want to use and session name.
Используйте это же имя сеанса для других actions. The .dll referenced is automatically added as
a бот dependency.

2. Use the Run function action to run a function from the .dll and save its output value as a variable.
3. After running the required functions, close the .dll reference. It is important to close the .dll

reference to free the memory of the operating system.
Windows and appropriate versions of Microsoft .NET Framework are available on the devices running
the DLLs.
To review the бот launcher logs, navigate to C:\ProgramData\AutomationAnywhere
\BotRunner\Logs\<current month>\Bot_Launcher-<today's date>.log.zip. Each
zipped folder contains a file with data on the code execution, which is useful for debugging.

Прим.:  Если файл .dll использует функции .NET или классы из другого файла .dll, необходимо
вручную добавить второй файл .dll как зависимость от бот.

Бот dependencies

When you import multiple DLLs that have one main DLL and other DLLs are referenced from it, ensure
you have all the DLLs in one folder. Also, the referenced DLLs must be called using a session name that
is different from the name used in the main DLL. Your бот execution will fail if the same session name is
used in both the main and the referenced DLLs.

Действия in the DLL пакет

The DLL пакет includes the following actions:

Действие Описание

Закрыть См. Close action

Открыть См. Open action
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Действие Описание

Выполнить функцию
(предыдущая версия)

See Using the Run function action.

Прим.:
• The Run function (Legacy) action is no longer available in the Run

DLL пакет. We recommend that you use the Run Function action
from the Run DLL пакет because this action is an improved version of
the Run function (Legacy) action.
Note that existing боты that use the Run function (Legacy) will
continue to run successfully without any issues.

• This action is called Run function (Legacy) starting from Enterprise
A2019.16. The action is called Run function in Enterprise A2019.15
and previous releases.

Выполнить функцию См. раздел Использование action «Выполнить функцию».

Supported data types in DLL functions

The following table list the variables and data types that you can use as an input or output parameter in
DLL functions.

Прим.:  The Run function and Run function (Legacy) actions do not support any user-defined data
types in the Parameter to the function or Assign output to variable field.

Variable type as input or output parameters Supported data types in .NET

Строка • Char
• Byte
• Строка
• строка
• SByte

Число • UInt16
• Int16
• UInt32
• Int32
• UInt64
• Int64
• Int
• Одинарное
• Decimal
• Float
• Двойное

Логический • Логический
• bool
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Variable type as input or output parameters Supported data types in .NET

Дата/время • Дата/время

Список • UInt16[]
• Int16[]
• Int32[]
• Int64[]
• Int[]
• Char[]
• Single[]
• Decimal[]
• Float[]
• Double[]
• Boolean[]
• bool[]
• Byte[]
• String[]
• Datetime[]
• List<UInt16>
• List<Int16>
• List<Int32>
• List<Int64>
• List<Int>
• List<Char>
• List<Single>
• List<Decimal>
• List<Float>
• List<Double>
• List<Boolean>
• List<bool>
• List<Byte>
• List<String>
• List<Datetime>
• List<SByte>
• List<UInt32>
• List<UInt64>

Прим.:  The C# IList data type is not supported
and does not work with the Automation 360 List
data type.
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Variable type as input or output parameters Supported data types in .NET

Таблица • UInt16[,]
• Int16[,]
• Int32[,]
• Int64[,]
• Int[,]
• Char[,]
• Single[,]
• Decimal[,]
• Float[,]
• Double[,]
• Boolean[,]
• bool[,]
• Byte[,]
• String[,]
• Datetime[,]
• Byte[,]
• UInt32[,]
• UInt64[,]

Прим.:  The Table type variable is equivalent to
a two-dimensional array type variable in .NET.
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Variable type as input or output parameters Supported data types in .NET

Словарь • Dictionary<String,UInt16>
• Dictionary<String,Int16>
• Dictionary<String,Int32>
• Dictionary<String,Int64>
• Dictionary<String,Int>
• Dictionary<String,Char>
• Dictionary<String,Single>
• Dictionary<String,Decimal>
• Dictionary<String,Float>
• Dictionary<String,Double>
• Dictionary<String,Boolean>
• Dictionary<String,bool>
• Dictionary<String,Byte>
• Dictionary<String,String>
• Dictionary<String,Datetime>
• Dictionary<Int,String>
• Dictionary<Decimal,String>
• Dictionary<Boolean,String>
• Dictionary<String,SByte>
• Dictionary<String,UInt32>
• Dictionary<String,UInt64>

Прим.:  When creating the .Net DLL function,
use the IDictionary data type instead of the
Dictionary data type.

Задачи, связанные с данной
Example of using the DLL package
Build a very simple DLL that will generate a message. Create a бот to run the DLL.

Close action
The Close action in the DLL пакет enables you to close the DLL reference.

Настройки

Closes the current session. In the Session name field, enter the name of the session.

Open action
The Open action in the DLL пакет enables you to open the reference file.

Настройки

• In the File path field, specify the location of the path.
• Select any of the following tabs to specify the location of the DLL you want to use:

• Control Room file: Use a DLL that is available in the Control Room.
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• Desktop file: Use a DLL that is available on a device.
• Переменная. Use a file variable to specify the location of the DLL.

• Select any of the following tabs to create a DLL session:
• Локальный сеанс Укажите имя сеанса, которое можно использовать только в текущем бот.
• Глобальный сеанс Specify a session name that can be used across multiple боты such as parent

боты, child боты, and other child боты of the parent боты.
См. раздел Sharing sessions across боты.

• Переменная. Укажите переменную сеанса, которую можно применить для совместного
использования этого сеанса с другими дочерними боты.
When you run the бот, it passes the session variable to the child бот, which enables the child бот to
use the DLL opened in the parent бот.

Прим.:  The DLL пакет supports only DLLs written in C#.

Sharing sessions across боты
You can share a session across multiple боты so that you can use the same DLL, Microsoft Excel
worksheet, and terminal across these боты. You can share a session across child боты, parent боты, and
other child боты of the parent боты.
Use the Global session option in the Open action of the DLL пакет to pass on the exact state of an
application or DLL from one бот to another бот and vice versa.
Sharing a session eliminates the need to repeatedly open and close a session when using the same
file across multiple боты. When you share a session across боты, all subsequent actions in that бот,
child боты, parent боты, and other child боты of the parent боты can use that DLL session without any
additional steps by using the same global session name in these боты.
For example, consider you have added the Open action with the Global session selected at the eighth
line of a бот. All the actions that are executed after the eighth line in the current бот, child боты, and
parent боты can use that DLL session without any additional step.

Прим.:  Use the Open action to open a global session as the first action in your боты.

Using the Run function (Legacy) action
Use the Run function (Legacy) action to run a function within the .dll file and specify the parameters
to pass a function and store the output as a variable.
• Use a dictionary variable to pass the parameters to a function. The dictionary key contains the

parameter name to pass to a function.
• Если файл .dll использует функции .NET или классы из другого файла .dll, необходимо

вручную добавить второй файл .dll как зависимость от бот.

Бот dependencies
• При применении action Выполнить функцию или Выполнить функцию (устарело)

убедитесь, что используете данные поддерживаемых типов для DLL-функций.
См. раздел DLL пакет.

Follow these steps to run a function:
1. In the Действия palette, double-click or drag the Run function (Legacy) action from the DLL

пакет.
2. В поле Имя сеанса введите имя сеанса.
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3. В поле Введите пространство имен укажите пространство имен.
Можно указать любое из пространств имен, определенных в DLL-файле.

Прим.:  Убедитесь, что в поле указано правильное значение.

Важное замечание:  Это поле заполняется с учетом регистра букв.

4. В поле Введите имя класса укажите имя класса.
You can specify the name of any classes available in the namespace.

Важное замечание:  Это поле заполняется с учетом регистра букв.

5. В поле Введите имя функции, которую требуется выполнить укажите имя выполняемой
функции.
Ensure that the name you have provided is correct and available in the class specified in the previous
step.

Важное замечание:  Это поле заполняется с учетом регистра букв.

6. Необязательно: In the Parameters to the function list, select the variable that contains all the
parameters needed by the function.
You can use Boolean, datetime, dictionary, list, number, string, or table variable types to pass
parameters to the function.

Прим.:  Use the dictionary subtype Any to enable the бот to pass parameters of different data types
to the function including Boolean, numeric, and string.

Specify the dictionary key as the parameter name to provide the dictionary value as the parameter
value. For example, you have a function ReturnSum that returns the sum of two numeric values and
want to pass Param1 and Param2 as its parameters. Configure a dictionary variable with two keys:
Param1 and Param2, each with the value that you want to pass.

7. Необязательно: В списке Присвоить выходные данные переменной выберите переменную
для хранения выходных данных функции.
Для сохранения выходных данных, возвращаемых функцией, в зависимости от их типа можно
использовать следующие типы переменных: логические, дата/время, переменные словаря,
списка, числовые, строковые или переменные таблицы.

8. Щелкните Сохранить.

Использование action «Выполнить функцию»
action Выполнить функцию используется для выполнения функции внутри .dll, указания
параметров для передачи функции и сохранения выходных данных в виде переменной.
• Это action позволяет передавать параметр любого типа. Чтобы использовать переменную

словаря для передачи параметров функции, используйте функцию Выполнить функцию
(Устаревшее)action.
Using the Run function (Legacy) action

• Действие Выполнить функцию не поддерживает использование форм Windows.
• Если файл .dll использует функции .NET или классы из другого файла .dll, необходимо

вручную добавить второй файл .dll как зависимость от бот.

Бот dependencies
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• Это action поддерживает перегруженные функции начиная с версии Enterprise A2019.17. action
может обрабатывать файлы .dll, содержащие несколько одноименных функций. Оно вызывает
функцию в зависимости от количества переданных параметров.

• При применении actions Выполнить функцию или Выполнить функцию (устарело)
убедитесь, что используете данные поддерживаемых типов для DLL-функций.
DLL пакет

Для выполнения функции выполните указанные ниже действия.
1. На палитре Действия дважды щелкните или перетащите action Выполнить функцию из

пакет DLL.
2. В поле Имя сеанса введите имя сеанса.
3. In the Enter the namespace (Optional) field, specify the namespace.

Можно указать любое из пространств имен, определенных в DLL-файле.

Прим.:  Убедитесь, что в поле указано правильное значение.

Важное замечание:  Это поле заполняется с учетом регистра букв.

4. В поле Введите имя класса укажите имя класса.
You can specify the name of any of the classes available in the namespace.

Важное замечание:  Это поле заполняется с учетом регистра букв.

5. В поле Введите имя функции, которую требуется выполнить укажите имя выполняемой
функции.
Ensure that the name you have provided is correct and available in the class specified in the previous
step.

Важное замечание:  Это поле заполняется с учетом регистра букв.

6. Необязательно: В разделе Входные параметры щелкните кнопку Добавить параметры.
a) В диалоговое окне Сведения о параметре DLL в поле Имя параметра введите имя

параметра.
b) В списке Тип параметра выберите тип данных.

Для типа данных «Целое число» (UInt16, Int16, Int32, Int64, Int, Single, Float, Decimal,
Double, UInt32 или UInt64) в качестве входного параметра можно использовать значение из
хранилища учетных данных или переменную учетных данных.

c) В поле значение введите значение, которое требуется передать.
Если выбрать тип данных «Целое число», для выбора доступны указанные ниже варианты.

• Число. В этом поле введите значение, которое требуется передать.
• Учетные данные. Чтобы использовать значение из хранилища учетных данных,

выберите Учетные данные. Чтобы использовать переменную учетных данных, выберите
Переменная.

Подробнее о хранилищах учетных данных и о том, как их использовать, см. в разделе Credentials
and ячейки in the Credential Vault.
Для добавления нескольких параметров повторите шаг 6.

Важное замечание:  Имена добавляемых параметров и их порядок должны быть такими же,
как в функции DLL.
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7. Use the Run function in background option when no Windows system-related operations, such
as such as keystroke, mouse click, or window switching, are called under the C# DLL. You can select
the Run function in background check box to bypass the intermediate window (AAZeroSizeForm)
and run the C# DLL under the console application without the form. We recommend that you select
this check box if the DLL function is not interacting with the Windows API to perform operations
such as keystroke, mouse click, or window switching. Эта функция также помогает повысить
производительность выполнения DLL, если установлен флажок Выполнять функцию в
фоновом режиме.

8. Необязательно: В списке Присвоить выходные данные переменной выберите переменную
для хранения выходных данных функции.
Для сохранения выходных данных, возвращаемых функцией, в зависимости от их типа можно
использовать следующие типы переменных: логические, дата/время, переменные словаря,
списка, числовые, строковые или переменные таблицы.

9. Щелкните Сохранить.

Document Extraction пакет
The Document Extraction пакет enables you to extract data from documents and download that data. This
пакет is for processing documents in Document Automation.
When a new learning instance is created, the Control Room automatically creates a folder with the same
name as the learning instance in the Automation > Document Workspace folder. Within that folder,
the Control Room creates the following two боты:
• Extraction bot: Extracts data from defined fields in uploaded documents.
• Download bot: Downloads the extracted data to a specific folder on the device or shared network.

Действия в Document Extraction пакет

This пакет includes the following actions:

Действие Описание

Download data См. Using Download data action

Извлечь данные См. Using Extract data action

Понятия, связанные с данным
Document Automation
Document Automation — это новое Cloud решение для интеллектуальной обработки документов,
которое бизнес-пользователи могут настроить для автоматического чтения и быстрой обработки
документов с использованием предварительно обученных моделей и обратной связи при валидации.
Задачи, связанные с данной
Создание обучаемого экземпляра в Document Automation
Begin processing documents by creating a learning instance to extract data from invoices, utility bills,
or receipts. Обучаемый экземпляр — это структура, содержащая такую информацию, как тип
документа, язык и поля для извлечения.

Using Extract data action
TaskBots use the Extract data action to process documents uploaded to Document Automation.
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When you create a learning instance in Document Automation, the Control Room automatically creates the
extractionbot. To edit this бот, navigate to Automation > Document Workspace, select the folder
with the same name as the learning instance, and open the extractionbot.
The following table describes the action fields.

Прим.:  We do not recommend changing the variables in these fields as that might break the process.

Поле Описание

Document to extract File path to the uploaded document

Имя обучаемого экземпляра Name of the learning instance associated with
this бот

Output results Specify where to hold Document Automation
data:
• Uploaded to Document Automation

server: Data generated during extraction is
uploaded to the server for further processing
(such as validation) and later downloaded by
a бот running the Download data action.

• Saved to local folder: Data generated
by Document Automation is not sent to the
server and is saved to the specified folder
path.

Прим.:  If you select this option, Document
Automation does not send files for validation,
since that requires the use of the Document
Automation server. In addition, you can
remove the бот running the Download data
action from the process, since selecting this
option makes that бот redundant.

Service account If the learning instance associated
with this бот will process documents in
Google Document AI, click Pick to select the
credential that contains your Google Document
AI security token.

Document AI endpoint URL If the learning instance associated with
this бот will process documents in Google
Document AI, provide the URL to your service
account.

GroupLabel (optional) If the learning instance was created in
Automation 360 IQ Bot and connected to
Document Automation, this field is auto-filled
with the applicable document group name.

Задачи, связанные с данной
Создание обучаемого экземпляра в Document Automation
Begin processing documents by creating a learning instance to extract data from invoices, utility bills,
or receipts. Обучаемый экземпляр — это структура, содержащая такую информацию, как тип
документа, язык и поля для извлечения.
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Configure Extract action to process documents in Google Document AI
Provide the credential that is holding the Google Document AI API key to the Extraction bot.
• Configure key for Google Document AI
• Создание обучаемого экземпляра в Document Automation
• Login to your Google Document AI account, navigate to the processor, and set the default version to

pretrained-invoice-v1.1-2021-04-09
• Copy the Google Document AI prediction endpoint

1. Navigate to Automation > Private tab > Document Workspace and click the folder with the
same name as the learning instance to configure the бот.

2. Open the Extraction bot and click the Document Extraction action to edit it.
3. In the Service account field, click Pick to select the doc-ai-credential credential.
4. Provide the Google Document AI prediction endpoint URL.
5. Щелкните Сохранить.

Using Download data action
TaskBots use the Download data action to download data from successfully processed documents in
Document Automation.
When you create a learning instance in Document Automation, the Control Room automatically creates the
downloadbot. To edit this бот, navigate to Automation > Document Workspace, select the folder
with the same name as the learning instance, and open the process. By default, the process contains four
downloadbots. You can edit the output format in the боты: Change output format from CSV to JSON

Важное замечание:  Only edit the боты in the process. We do not recommend editing the
downloadbot in the folder with the same name as the learning instance.

The following table describes the Download data action fields:

Поле Описание

Document Id The document to download

Тип документа The output file type:
• Output file (CSV): Used for downloading

successfully processed documents to CSV
format.

• Output file (JSON): Used for downloading
successfully processed documents to JSON
format.

• Input file: Used for downloading failed
documents in the file type that they were
uploaded.

Путь к выходной папке Specifies the file path where to download the
document

Удалить файлы Removes files from the Document Automation
server after they are downloaded
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Ссылки, связанные с данной
About the AARI process in Document Automation
Document Automation uses Automation Anywhere Robotic Interface technology to manage the end-to-end
document extraction process. When you create a learning instance in Document Automation, the system
also creates an AARI process. Review the following guide to understand the logic.

Эл. почта пакет
Эл. почта пакет содержит actions для автоматизации задач, связанных с электронной почтой, с
помощью веб-служб Exchange (EWS), Microsoft Outlook и других серверов эл. почты. You can use
these actions for sending, receiving, and modifying messages, folders, and the status of messages.

Прим.:
• The Эл. почта пакет supports the email automation of a shared mailbox in Outlook for Office 365/

Microsoft 365 using IMAP/EWS protocols, and OAuth 2.0 authentication using Client Credentials and
Authorization Code with PKCE grant flows. You can automate emails retrieved from a shared mailbox
and perform email-related tasks by accessing each folder(s) and its subfolder(s) in the shared mailbox.
Ensure that you have set up the shared mailbox in your Outlook application. Note that sending,
forwarding, and replying to emails using a shared mailbox is not supported.

• Proxy is supported for EWS OAuth 2.0. When you create a бот that uses EWS OAuth2 for
authentication and the Bot Runner machine is configured behind the firewall, then all outbound
requests are routed through the proxy server configured on the Bot Runner machine.

• When you read emails in a loop using a Microsoft Outlook Client connection with a subject filter, the бот
cannot read undelivered emails, if the subject contains these receipts:
• Delivery receipt
• Read receipt
• Undelivered receipt

Outlook client does not support this feature due to the third-party library it uses.
We recommend that you use Email server > IMAP to connect, read and filter such emails.

Эл. почта пакет поддерживает протоколы EWS, POP3, SMTP и IMAP и позволяет выполнять
указанные ниже задачи.
• Организация и управление сообщениями эл. почты и папками.
• Загрузка вложений из сообщений эл. почты в определенные папки на устройствах.
• Извлечение данных из сообщений эл. почты в переменные для использования в качестве

извлеченных данных в других приложениях. Например, вы можете извлечь данные из эл. почты
отправителя и сохранить их в электронной таблице Microsoft Excel.

Прим.:  Если нужно автоматизировать задачу, связанную с эл. почтой, на устройстве,
использующем Microsoft Outlook, убедитесь, что приложение Outlook открыто.

Прим.:
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• If your current office installation is any of the following:
• Microsoft 365 Apps for Enterprise
• Office 2016, 2019, or 2021 (Consumer Version 2009 or later)

Then you do not need to install the Microsoft Access Database Engine as an additional component in
your system.
However, if you have both Microsoft 365 Apps and the Microsoft Access Database Engine are installed
on your system, then you can uninstall the Microsoft Access Database Engine and repair Microsoft 365
Apps.
Microsoft recommends that you do not install the Microsoft Access Database Engine driver separately
because both the Microsoft Access Database Engine 2016 and Microsoft 365 Apps use the same major
version identifier (16.0). To learn more about the Microsoft Access Database Engine driver installation
requirement, see Unable to use the Access ODBC or OLEDB provider

• When you send an email, reply, or forward, the attachment size allowed in the email depends on your
internet speed (timeout of 120 seconds) and the email server restrictions. If sending an attachment
takes more than 120 seconds, the system displays an error due to timeout.

Considerations

Прим.:  Некоторые из actions должны использоваться в action Цикл. См. раздел Using the For each
mail in mail box iterator.

Сообщения эл. почты извлекаются в соответствии с порядком папок, указанных в поле «Входящие».
В пределах каждой папки извлекаемые сообщения эл. почты упорядочиваются по дате и времени
получения, в порядке, обратном порядку поступления. Кроме того, фильтры можно применить к
указанным ниже полям.
• Типы сообщений эл. почты: Все, Прочитанные и Непрочитанные
• Тема
• Из определенной папки
• От определенного отправителя
• Ранее даты, на дату или позднее даты получения

Adhere to the following best practices when you filter and loop through folders that contain a large number
of email messages:
• After you have processed email messages, move them to another folder so that their duplicate email

messages are not processed again during a subsequent run.
• Try to reduce the number of messages in the mailbox.
• The filtration works on the filter parameters provided by the user, such as type of email: All, Read, and

Unread; Subject; from a specific folder; from a specific sender; or before, on, or after received date).
Following are the types of filter mechanisms:
• Email server-side: The filtration that takes place on the server-side is much faster.
• Client-side: Filtration is performed on the local machine and is comparatively slow because the

mail messages are first retrieved from the remote server and then filtered in the local machine.
• Hybrid: Some parameters are filtered on the server side and some on the client side.
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• Here is an explanation of how the filtration process works for various server types:
• EWS: All filtration is done on the server side and is hence much faster.
• Outlook client: Nothing is filtered on the server side, but the filtration process is faster because

email messages are already present on the local machine.
• IMAP: Filtration for the Subject field is performed on the local machine and is slower. For the

Before, on, or after received date parameter, the filtration for date is performed on the remote
server, and for hour/min/second, it is performed on the local machine. For example, for the date
01/12/2022, filtration is performed on the remote server whereas for the time (hour/min/sec)
21:10:56, filtration is performed on the local machine.

• POP3: This server is the slowest of all because mails are retrieved from the remote server, and
filtration is done in the local machine.

We recommend connecting using the EWS server and Outlook client as the filtration process is much
faster when compared to IMAP and POP3 protocols.

• Always use the Disconnect action if the Connect action is used to release a resource.

Перед началом работы

Выполните указанные ниже actions в рамках Эл. почта пакет из числа доступных actions.
1. Установите соединение с сервером эл. почты с помощью action Подключить.

При установке подключения укажите сведения о сервере эл. почты и имя сеанса. Используйте
это же имя сеанса для других actions.
Нет необходимости устанавливать соединение для actions Переслать, Ответить и Отправить,
так как при использовании этих actions вы добавите сведения об отправителе и сервере эл.
почты.

2. Используйте actions для автоматизации задачи.
3. После того как все задачи, связанные с электронной почтой, будут автоматизированы,

завершите подключение к почтовому серверу с помощью action Отключить.

Важное замечание:  Необходимо включить параметры POP для автоматизации задачи, связанной
с эл. почтой, на сервере Gmail, использующем протокол POP3. См. раздел Чтение сообщений Gmail с
помощью POP.

Действия в Эл. почта пакет

пакет Эл. почта включает в себя указанные ниже actions.

Действие Описание

Изменить состояние См. раздел Change status action.

Проверить,
существует ли папка

См. раздел Check if folder exists action.

Удалить все См. раздел Delete all action.

Удалить См. раздел Удалить action.

Отключить См. раздел Disconnect action.

Подключить См. раздел Using Connect action for Эл. почта.
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Действие Описание

Переслать См. раздел Using the Forward action.

Переместить все См. раздел Move all action.

Переместить См. раздел Move action.

Ответить См. раздел Using Reply action.

Сохранить все
вложения

См. раздел Save all attachments action.

Сохранить вложения См. раздел Save attachment action.

Сохранить сообщение
эл. почты

См. раздел Save email action.

Отправить См. раздел Using the Send action.

Ссылки, связанные с данной
Цикл пакет
Use the Цикл package to run a sequence of actions repeatedly for a specific number of times or until a
specific condition is met.
Email server settings
The details about the mail server you provide when establishing a connection varies based on the email
server to which you are connecting.
Using dictionary variable for email properties
When you automate an email-related task, Рабочая область RPA retrieves various properties of an
email and stores the values of these properties in a dictionary variable. These properties are stored in a
dictionary variable when you use an email action within a loop action.

Change status action
The Change status action in the Эл. почта пакет enables you to change the statuses of emails to read or
unread. Используйте это action в рамках action Цикл.

Настройки

• In the Session name field, enter the name of the session that you used to connect to the email server
in the Connect .

• Change status to: Выберите параметр Прочитанные или Непрочитанные, чтобы изменить
статус сообщения эл. почты.

Прим.:
• Microsoft Outlook supports this action.
• Серверы POP3 не поддерживают и не сохраняют статус «Прочитанные» или «Непрочитанные»

сообщений эл. почты.

Check if folder exists action
Use the Check if folder exists action in the Эл. почта пакет to verify whether a folder with the name you
specified exists in the email server.
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Настройки

• In the Session name field, enter the name of the session that you used to connect to the email server
in the Connect .

• В поле Имя папки введите имя папки, которую нужно проверить.

Прим.:  Это поле заполняется без учета регистра букв.

• In the Select the destination boolean variable list, select a Boolean variable to store the output
of the result. The output is either True (folder exists) or False (does not exist). В  отображается
описательное имя переменной по умолчанию. If you create several output variables, subsequent
variable names are appended with a -1, -2, -3, and so on to avoid duplication.

Delete all action
Use the Delete all action in Эл. почта пакет to delete read, unread, or all emails from the specified folder.

Настройки

• In the Session name field, enter the name of the session that you used to connect to the email server
in the Connect .

• Выберите параметр Все, Прочитанные или Непрочитанные, чтобы указать тип сообщения эл.
почты, которое вы хотите удалить.

Прим.:
• При использовании протокола POP3 на сервере эл. почты это action приводит к удалению всех

сообщений эл. почты.
• В настоящее время Microsoft Outlook не поддерживает это action.

Удалить action
Use the Delete action in Эл. почта пакет to delete the specified email from the inbox. Use this action
within a Цикл action.

Настройки

In the Session name field, enter the name of the session that you used to connect to the email server in
the Connect .

Прим.:  Microsoft Outlook supports this action.

Disconnect action
Use the Disconnect action in Эл. почта пакет to terminate the connection established with the email
server.
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Настройки

In the Session name field, enter the name of the session that you used to connect to the email server in
the Connect .

Using Connect action for Эл. почта
Используйте action Подключить, чтобы установить соединение с сервером электронной почты.
Это первое action, которое вы должны использовать для автоматизации задачи, связанной с
электронной почтой.
You can use OAuth 2.0 to authenticate with the email server for email automation. Based on your email
service provider, perform the relevant steps:
• Outlook/Office 365

• If you use Client credentials flow authentication mode, then perform the following steps:
1. Log in to the Microsoft Azure portal.
2. Register an application with the Microsoft identity platform to obtain the client ID and tenant ID.

See Register an application.
3. Add a Client secret. See Add a client secret.
4. Based on which mail server you connect to, perform the relevant steps:

• IMAP/POP3
Add the POP and IMAP permissions to your AAD application . See Authenticate an IMAP, POP
or SMTP connection using OAuth.

• EWS
• Configure for app-only authentication. See Configure for app-only authentication.
• Configure an application access policy and limit the scope of application permissions. See

Configure application access policy.

• If you use the Authorization code with PKCE authentication mode, then perform the following
steps:
1. Log in to the Microsoft Azure portal.
2. Register an application with the Microsoft identity platform to obtain the client ID and tenant ID.

See Register an application.
3. When registering the application, set the redirect URI to http://localhost:9999/

callback.
4. Add permissions with type delegated for IMAP, POP3, and SMTP and grant the application the

required permission for Microsoft Graph to the application.

• Gmail
To authorize your application with Gmail using the Authorization code with PKCE authentication
method, perform the following steps:
1. Configure the OAuth2.0 settings in the Google Cloud Platform (GCP) and retrieve the necessary

credentials to connect Automation 360 with your G Suite applications.
2. If you have not already done so, create a project.
3. To generate the Client ID and Client secret, complete the steps in Setting up OAuth 2.0.
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Прим.:
• Select the Web application option.
• Add this authorized redirect URI: http://localhost:8888/Callback.

4. Complete the steps to set up user consent for the username that you will use to connect to the
Automation 360.

Прим.:
• Client Credentials flow does not support Gmail.
• The Client Credentials and Authorization code with PKCE authentication modes do not support Yahoo

and MSN mail servers.

Important:  If you want to use both the authentication mode (Client credentials and Authorization code
with PKCE), you must register on two separate applications.

Прим.:  При подключении к серверу Exchange Web Services многофакторная проверка подлинности
должна быть отключена, в том числе во всех политиках безопасности на уровне организации. If
multi-factor is not disabled completely, users can encounter connection or authorization errors.

Это action позволяет вам предоставить учетные данные и сведения о сервере электронной почты
и связать эту информацию с именем сеанса. Используйте это же имя сеанса для других actions Эл.
почта. Таким образом, вам придется предоставить информацию о сервере только один раз.
Чтобы установить соединение с сервером электронной почты, выполните указанные ниже действия.
1. На палитре Действия дважды щелкните или перетащите action Подключить из пакет Эл.

почта.
2. Введите имя сеанса.
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3. Для параметра Outlook, Сервер электронной почты или EWS укажите, нужно ли установить
соединение с Microsoft Outlook или почтовым сервером.
When you establish a connection with Microsoft Outlook, email messages are processed from the
shared mailbox. Ensure that you have set up the shared mailbox in your Outlook application.

Прим.:
• This feature is supported only for Outlook.
• You can select only one mailbox from the list of mailboxes in the shared mailbox.
• The meeting invitation is not read in Outlook because the бот does not select calendar invites as

email objects. This feature is not currently supported.

• Если вы выбрали параметр Outlook, предоставлять дополнительные сведения не требуется.
• Если вы выбрали параметр Сервер электронной почты заполните указанные ниже поля.

Прим.:  Для получения информации об узле и порте, которые должны использоваться для
разных почтовых серверов, см. Email server settings.

• Использовать безопасное подключение (SSL/TLS). Выберите этот параметр, если
вы хотите использовать безопасное подключение к почтовому серверу.

• Узел. Enter the name of the mail server.

Прим.:  Это поле заполняется без учета регистра букв.

• Порт. Enter the port number of the server.
• Протокол. Select either IMAP or POP3 protocol.
• Authentication mode: Choose from the following authentication modes:

• Basic: Uses the username and password.
• OAuth2 – Authorization code with PKCE: See Microsoft identity platform and OAuth 2.0

authorization code flow
• OAuth2 – Client credentials: See Microsoft identity platform and the OAuth 2.0 client

credentials flow

Depending on the authentication mode that you selected, you must specify the details in the
following fields as applicable.
• Username: Enter the username that you want to use to access the mail server.

For example, john.smith@myCompanyName.com
• Password: Enter the password for the username you provided.
• For Client ID, Tenant ID, Redirect URI, and Client secret fields, enter the information

that is provided for your account on your Azure portal.
• Email provider: Select your email service provider from the drop-down list.

• Outlook/Office365
If you select this option, then provide the Tenant ID.

• Gmail

For Username, Password, Tenant ID, Client ID, and Client secret fields, choose from
Credential, Variable, or Insecure string tab:
• Credential: Use a value available in the credential vault.
• Variable: Use a user-defined variable that stores the values.
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• Insecure string: Manually enter a value.

• Если вы выбрали параметр EWS, заполните указанные ниже поля.
• Версия Exchange. Выберите версию, которую использует ваша организация.

• Exchange Server 2013
• Exchange2010_SP2
• Exchange2010_SP1
• Exchange2010
• Exchange2007_SP1

• Azure cloud: Выберите продукт, который использует ваша организация.
• Azure глобальное. Для клиентов коммерческой версии Microsoft 365

(login.microsoftonline.com)
• Azure US GCC High. Для клиентов версии Microsoft 365 для государственных

учреждений (login.microsoftonline.us)

• Необязательно. Имя домена:
• Если вы являетесь клиентом Office 365 и оставили это поле пустым, Рабочая область

RPA использует smtp.office365.com для подключения к серверу.
• Если вы являетесь клиентом Office 365 и ввели имя домена в поле Имя

пользователя, обязательно введите smtp.office365.com в это поле.
• Если вы не являетесь клиентом Office 365, введите имя домена вашей организации.

Иначе Рабочая область RPA использует имя домена, которое вы указали в поле Имя
пользователя.

• Authentication mode: Choose from the following authentication modes:

Прим.:  From Automation 360v.27 or later, the authorization type OAuth2-Silent
authentication mode is renamed to OAuth2-ROPC, and the OAuth2-Interactive
authentication mode is renamed to OAuth2-Implicit.

• Basic: Uses the username and password.
• OAuth2-ROPC: See Microsoft identity platform and OAuth 2.0 Resource Owner Password

Credentials
• OAuth2-Implicit: See Microsoft identity platform and implicit grant flow
• OAuth2 – Authorization code with PKCE: See Microsoft identity platform and OAuth 2.0

authorization code flow
• OAuth2 – Client credentials: See Microsoft identity platform and the OAuth 2.0 client

credentials flow

Depending on the authentication mode that you selected, you must specify the details in the
following fields as applicable.
• Username: Enter the username that you want to use to access the mail server.

For example, john.smith@myCompanyName.com
• Password: Enter the password for the username you provided.
• For Client ID, Tenant ID, Redirect URI, and Client secret fields, enter the information

that is provided for your account on your Azure portal.
• Test connection: Click Test connection to sign in to your account, accept the

permissions requested to authenticate, and establish a connection with the server.
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Прим.:  When you perform desktop operation and click Test connection to sign in to your
account, then add this redirect URI: https://outlook.office365.com.

For Username, Password, Tenant ID, Client ID, and Client secret fields, choose from
Credential, Variable, or Insecure string tab:
• Credential: Use a value available in the credential vault.
• Variable: Use a user-defined variable that stores the values.
• Insecure string: Manually enter a value.

4. Щелкните Сохранить.

Email server settings
The details about the mail server you provide when establishing a connection varies based on the email
server to which you are connecting.
The following table provides information about the host name and the port you must use when
establishing a connection to the specified mail server:

Server For reading or retrieving
emails

For sending emails

Microsoft Outlook/Microsoft
Office 365

Host: outlook.office365.com
Порт. 993

Host: outlook.office365.com,
Порт. 993
Host:smtp.office365.com
Порт. 587

Gmail Host: imap.gmail.com
Порт. 993

Host: smtp.gmail.com
Порт. 587

Yahoo Host: imap.mail.yahoo.com
Порт. 993

Host: smtp.mail.yahoo.com
Порт. 465 or 587

MSN Host: imap-mail.outlook.com
Порт. 993
For POP3:
Host: pop-mail.outlook.com
Порт. 993

Host: smtp-mail.outlook.com
Порт. 465 or 587

The Эл. почта пакет supports nonstandard ports in the range of 1 through 65535 for the SMTP server.

Additional configuration for Gmail and Yahoo

If you are using a Gmail account to automate an email-related task, ensure that the option to allow access
for less secured apps is enabled and IMAP must be enabled to access Gmail from other clients using
IMAP . This is required to enable a TaskBot to send email using a Gmail account.
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To enable access for less secure apps:
1. Log in to your Gmail or Yahoo account.
2. Go to account settings.
3. Enable the option to allow less secure apps.

Прим.:  You can use App password if the application does not support Sign in with Google to connect
apps to your Google Account. App passwords can only be used with accounts that have 2-Step Verification
turned on.
As a best practice, use OAuth 2.0 authentication to access G Suite account data.

If you are using a Yahoo account to automate an email-related task, ensure that you generate the app
password from the Yahoo account security page. Use the app password and the email address to log in to
your email account.

Using the Forward action
Use the Forward action to forward emails and attachments to one or more recipients. To forward emails
as plain text or HTML through Exchange Web Services (EWS), Microsoft Outlook, or other email servers,
use this action within a Loop action.
To forward emails, follow these steps:
1. In the Действия palette, double-click or drag the Forward action from the Эл. почта пакет.
2. In the To address field and the optional Cc and Bcc fields, enter the email addresses of the

recipients.

Прим.:  The To address, Cc, and Bcc fields are not case-sensitive.
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3. Необязательно: Чтобы указать, следует ли прикрепить несколько файлов в виде списка или
создать переменную для хранения значений списка файлового объекта, выберите вкладку
Список или Переменная во Вложении.
Вариант Описание

Список • Выберите вложение из местоположения:
• Файл Control Room. Enables you to

select an attachment that is available in a
folder.

• Профиль рабочего стола. Enables you
to select an attachment that is available on
your device.
Вы можете указать комбинацию
статического пути или строковую
переменную. Чтобы использовать как
строковую переменную, скопируйте
статический путь с рабочего стола
и создайте переменную типа string.
Введите имя Переменной и вставьте
путь к файлу в поле Значение по
умолчанию. Нажмите F2, чтобы
вставить значение пути к файлу.

• Переменная. Enables you to specify the
file variable that contains the location of
the attachment.

• Укажите путь, который вы хотите вложить,
в поле Значение. Щелкните Добавить,
чтобы вложить несколько файлов.

Переменная Позволяет указать список файловых объектов,
содержащих местоположение вложений.
Создайте новую переменную типа Список
с подтипом Файл и добавьте путь к
файлу в поле Значение по умолчанию
(необязательно). Вы можете выбрать файл
рабочего стола или Control room.

When you are attaching multiple files to an email, to separate the file paths, if you are connected
with EWS, use a comma (,), and if you are connected to an email server or Microsoft Outlook, use a
semicolon (;).

4. Необязательно: Select the Raise error if attachments are missing (desktop only) check box to
verify that you have attached a file and the attached file exists.

Вариант Результат

The Raise error if attachments are
missing (desktop only) check box is
selected

If a file is not attached, the email is not sent
and the бот encounters an error.

The Raise error if attachments are
missing (desktop only) check box is not
selected

The email is sent even if a file is not
attached.
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5. Выберите формат, который вы хотите использовать, из следующих вариантов:
Вариант Описание

Обычный текст Используйте обычный текст в теле сообщения
без эффектов форматирования, таких
как полужирный шрифт, курсив или
подчеркивание, и без специальных вариантов
оформления.

Код HTML Используйте сценарий HTML в теле письма,
если хотите, чтобы содержимое каждый раз
отображалось в определенном виде. Вы также
можете включить интерактивные элементы,
например ссылки.

Редактор дизайна HTML Используйте этот параметр для создания
и настройки макета и текста сообщения
электронной почты. Используйте панель
инструментов редактора для внесения
различных изменений в текст, например
применения полужирного шрифта, курсива и
других эффектов форматирования, вставки
ссылок, изменения шрифта и размера текста.
Содержимое можно скопировать из редактора
дизайна и вставлять его в другие окна.

6. Необязательно: Enter the content you want to send along with the email in the Message field.
The email will be appended to the message you have specified.

7. Необязательно: Select the Include Go Green message at the end of the email check box.
The Go Green message appends the following text to the bottom of the email body: Please
consider the environment before printing. Let's Go Green!
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8. Select the Email server, EWS or Outlook option from the Send email via list to specify whether to
send the emails using Microsoft Outlook or a mail server.
• Если вы выбрали параметр Outlook, предоставлять дополнительные сведения не требуется.
• Если вы выбрали параметр Сервер электронной почты заполните указанные ниже поля.

Прим.:  Для получения информации об узле и порте, которые должны использоваться для
разных почтовых серверов, см. Email server settings.

• Узел сервера эл. почты. Введите узел, к которому хотите подключиться.

Прим.:  Если вы используете узел Outlook.office365.com, существует лимит на
30 отправленных сообщений в минуту и 10 000 получателей в день.

• Порт сервера эл. почты. Введите порт, который нужно использовать для установления
соединения.

• Использовать безопасное подключение (SSL/TLS). Выберите этот параметр, если
вы хотите использовать безопасное подключение к почтовому серверу.

• На сервере требуется проверка подлинности. Select this option if the server requires
credentials for access.

• Authentication mode: Select the authentication modes:
• Basic
• OAuth2 – Authorization code with PKCE

Depending on the authentication mode that you selected, you must specify the details in the
following fields as applicable.
• Username: Enter the username that you want to use to access the mail server.

For example, john.smith@myCompanyName.com
• Password: Enter the password for the username you provided.
• For Client ID, Tenant ID, Redirect URI, and Client secret fields, enter the information

that is provided for your account on your Azure portal.
• Email provider: Select your email service provider from the drop-down list.

• Outlook/Office365
If you select this option, then provide the Tenant ID.

• Gmail

For Username, Password, Tenant ID, Client ID, and Client secret fields, choose from
Credential, Variable, or Insecure string tab:
• Credential: Use a value available in the credential vault.
• Variable: Use a user-defined variable that stores the values.
• Insecure string: Manually enter a value.

• If you have selected the EWS option, you do not need to provide any additional details.

9. Щелкните Сохранить.

Move all action
The Move all action in the Эл. почта пакет enables you to move all emails from one folder to another in
the email server.
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Настройки

• In the Session name field, enter the name of the session that you used to connect to the email server
in the Connect .

• В поле Путь к папке назначения в почтовом ящике укажите путь к папке, куда нужно
переместить сообщение эл. почты.

• Выберите сообщения эл. почты для перемещения: Все, Прочитанные или Непрочитанные
• В поле Из определенной папки укажите папку, из которой следует переместить сообщения эл.

почты. Например, Inbox/project1.

Прим.:  Для сервера эл. почты, использующего протокол POP3, можно получать сообщения эл.
почты только из папки входящих сообщений.

• Необязательно. Укажите одно из указанных ниже условий.
• Если тема содержит: Введите ключевые слова, разделенные точкой с запятой.

How subject filter works when moving emails

Прим.:  The When subject contains field is case sensitive. If you have established a connection
with the EWS server and when you enter text inside a pair of double quotation marks ("") in the
When subject contains field, the бот retrieves all the email messages whose subject exactly
matches the text and the case that you entered inside a pair of double quotation marks.

• От определенных отправителей: Введите адреса эл. почты отправителей, разделенные
точкой с запятой.

• Если дата получения совпадает или идет после или Если дата получения идет до:
выберите переменную даты/времени из списка.

Прим.:  Поскольку папки в Gmail не поддерживаются, это action не поддерживается для Gmail.

Прим.:  Использовать action Переместить все внутри цикла нельзя. action Переместить все
предназначено для использования в условиях вне цикла.

Для получения дополнительной информации см. раздел Can Move all action be used within a loop? (A-
People login required)

Move action
The Move action in the Эл. почта пакет enables you to move an email from one folder to another in the
mailbox. Используйте это action в рамках action Цикл.

Настройки

• In the Session name field, enter the name of the session that you used to connect to the email server
in the Connect .

• In the Destination folder path in the mailbox field, provide the path to the destination folder
where you want to move the email. For example, Inbox/finance/1

• Keep the following considerations in mind when you use the Move action:
• You must use this action inside a loop.
• When you connect with an Email server and use the IMAP protocol, ensure that you use the

Move action as the last action in the email loop.
• This action is not supported for POP3 connections.
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• The бот encounters an error if the Delete action is used before the Move action.
• If you are connecting to Outlook, we recommend that you to use a Delay action after the Move

action. (Specify a maximum delay of more than 2 seconds). Delay is based on Outlook client
performance.

• For improved performance when moving a large number of emails, considering latency issues with
the Outlook client, we recommend using the Move all action instead of Move action when you
want to move more than 500 emails.

Using Reply action
Use the Reply action to send a response to an email with the same subject.
To send a reply to emails as plain text or HTML through Exchange Web Services (EWS), Microsoft Outlook,
or other email servers, use this action within a Loop action. This action does not include any files attached
to the original email.
Follow these to reply to an email:
1. In the Действия palette, double-click or drag the Reply action from the Эл. почта пакет.
2. In the Cc and Bcc fields, enter the email address of additional recipients.

Прим.:  The Cc and Bcc fields are not case sensitive.

3. Необязательно: Чтобы указать, следует ли прикрепить несколько файлов в виде списка или
создать переменную для хранения значений списка файлового объекта, выберите вкладку
Список или Переменная во Вложении.
Вариант Описание

Список • Выберите вложение из местоположения:
• Файл Control Room. Enables you to

select an attachment that is available in a
folder.

• Профиль рабочего стола. Enables you
to select an attachment that is available on
your device.
Вы можете указать комбинацию
статического пути или строковую
переменную. Чтобы использовать как
строковую переменную, скопируйте
статический путь с рабочего стола
и создайте переменную типа string.
Введите имя Переменной и вставьте
путь к файлу в поле Значение по
умолчанию. Нажмите F2, чтобы
вставить значение пути к файлу.

• Переменная. Enables you to specify the
file variable that contains the location of
the attachment.

• Укажите путь, который вы хотите вложить,
в поле Значение. Щелкните Добавить,
чтобы вложить несколько файлов.
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Вариант Описание

Переменная Позволяет указать список файловых объектов,
содержащих местоположение вложений.
Создайте новую переменную типа Список
с подтипом Файл и добавьте путь к
файлу в поле Значение по умолчанию
(необязательно). Вы можете выбрать файл
рабочего стола или Control room.

When you are attaching multiple files to an email, to separate the file paths, if you are connected
with EWS, use a comma (,), and if you are connected to an email server or Microsoft Outlook, use a
semicolon (;).

4. Необязательно: Select the Raise error if attachments are missing (desktop only) check box to
verify that you have attached a file and the attached file exists.

Вариант Результат

The Raise error if attachments are
missing (desktop only) check box is
selected

If a file is not attached, the email is not sent
and the бот encounters an error.

The Raise error if attachments are
missing (desktop only) check box is not
selected

The email is sent even if a file is not
attached.

5. Выберите формат, который вы хотите использовать, из следующих вариантов:
Вариант Описание

Обычный текст Используйте обычный текст в теле сообщения
без эффектов форматирования, таких
как полужирный шрифт, курсив или
подчеркивание, и без специальных вариантов
оформления.

Код HTML Используйте сценарий HTML в теле письма,
если хотите, чтобы содержимое каждый раз
отображалось в определенном виде. Вы также
можете включить интерактивные элементы,
например ссылки.

Редактор дизайна HTML Используйте этот параметр для создания
и настройки макета и текста сообщения
электронной почты. Используйте панель
инструментов редактора для внесения
различных изменений в текст, например
применения полужирного шрифта, курсива и
других эффектов форматирования, вставки
ссылок, изменения шрифта и размера текста.
Содержимое можно скопировать из редактора
дизайна и вставлять его в другие окна.

6. Enter the content you want to send along with the email in the Message field.
The email will be appended to the message you have specified.

7. Необязательно: Select the Include Go Green message at the end of the email check box.
The Go Green message appends the following text to the bottom of the email body: Please
consider the environment before printing. Let's Go Green!
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8. Select the Email server, EWS or Outlook option from the Send email via list to specify whether to
send the emails using Microsoft Outlook or a mail server.
• Если вы выбрали параметр Outlook, предоставлять дополнительные сведения не требуется.
• Если вы выбрали параметр Сервер электронной почты заполните указанные ниже поля.

Прим.:  Для получения информации об узле и порте, которые должны использоваться для
разных почтовых серверов, см. Email server settings.

• Узел сервера эл. почты. Введите узел, к которому хотите подключиться.

Прим.:  Если вы используете узел Outlook.office365.com, существует лимит на
30 отправленных сообщений в минуту и 10 000 получателей в день.

• Порт сервера эл. почты. Введите порт, который нужно использовать для установления
соединения.

• Использовать безопасное подключение (SSL/TLS). Выберите этот параметр, если
вы хотите использовать безопасное подключение к почтовому серверу.

• На сервере требуется проверка подлинности. Select this option if the server requires
credentials for access.

• Authentication mode: Select the authentication modes:
• Basic
• OAuth2 – Authorization code with PKCE

Depending on the authentication mode that you selected, you must specify the details in the
following fields as applicable.
• Username: Enter the username that you want to use to access the mail server.

For example, john.smith@myCompanyName.com
• Password: Enter the password for the username you provided.
• For Client ID, Tenant ID, Redirect URI, and Client secret fields, enter the information

that is provided for your account on your Azure portal.
• Email provider: Select your email service provider from the drop-down list.

• Outlook/Office365
If you select this option, then provide the Tenant ID.

• Gmail

For Username, Password, Tenant ID, Client ID, and Client secret fields, choose from
Credential, Variable, or Insecure string tab:
• Credential: Use a value available in the credential vault.
• Variable: Use a user-defined variable that stores the values.
• Insecure string: Manually enter a value.

• If you have selected the EWS option, you do not need to provide any additional details.

9. Щелкните Сохранить.

Save all attachments action
Use the Save all attachments action to save attachments from all emails on the email server to a
specified folder.
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Настройки

• In the Session name field, enter the name of the session that you used to connect to the email server
in the Connect .

• Выберите сообщения эл. почты для сохранения: Все, Прочитанные или Непрочитанные.
• В поле Сохранить вложения в папку укажите папку для сохранения вложений.

Прим.:  Это поле заполняется без учета регистра букв.

• Overwrite file(s): Select this option to overwrite an existing file with the same name. Если этот
параметр не выбран, загруженный файл вложения сохраняется с тем же именем, дополненным
числовым значением. При этом существующий файл не перезаписывается.

Прим.:
• Файлы вложения можно сохранять с именами, содержащими символ табуляции.
• При подключении к серверу Outlook изображения, встроенные в сообщения эл. почты,

загружаются вместе с вложениями.

Save attachment action
Use the Save attachment action to save attachments from one email to a specified folder. Используйте
это action в рамках action Цикл.

Настройки

• В поле Сохранить вложения в папку укажите папку для сохранения вложений.

Прим.:  Это поле заполняется без учета регистра букв.

• Overwrite file(s): Select this option to overwrite an existing file with the same name. Если этот
параметр не выбран, загруженный файл вложения сохраняется с тем же именем, дополненным
числовым значением. При этом существующий файл не перезаписывается.

Прим.:  При подключении к серверу Outlook изображения, встроенные в сообщения эл. почты,
загружаются вместе с вложениями.

Save email action
Use the Save email action in the Эл. почта пакет to save an email message as an EML file to a folder.
Используйте это action в рамках action Цикл.

Настройки

• In the Session name field, enter the name of the session that you used to connect to the email server
in the Connect .

• В поле Сохранить сообщения эл. почты в папку укажите папку для сохранения сообщений
эл. почты.

Прим.:  Это поле заполняется без учета регистра букв.
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• Заменить файлы: выберите этот параметр, чтобы перезаписать существующий файл с тем же
именем. If this option is not selected, the email message is saved with the same filename suffixed with
a numeric value; it does not overwrite the existing file.

Прим.:  Microsoft Outlook supports this action.

Using the Send action
Используйте action Отправить для отправки сообщения электронной почты. Это action позволяет
отправить сообщение электронной почты одному или нескольким получателям в Microsoft Outlook
или на почтовом сервере, прикрепить файлы и выбрать отправку письма в формате обычного текста
или HTML.
action Отправить позволяет прикрепить к сообщению электронной почты несколько файлов
различных форматов. Нет никаких ограничений на тип или размер файла, который вы можете
прикрепить. Однако применяются ограничения, установленные почтовым сервером, который вы
используете для отправки письма. Например, задача не будет выполнена, если файлы, которые вы
прикрепили к отправляемому письму, не соответствуют ограничениям, установленным почтовым
сервером.

Прим.:  Вложения, отправленные в рамках автоматизации электронной почты, подчиняются
политикам и правилам, установленным на уровне прокси-сервера, брандмауэра, антивируса,
сервера электронной почты, клиентского окружения и т. д.

Чтобы отправить письмо с учетной записи Gmail или Yahoo, включите доступ к менее безопасному
приложению для этой учетной записи. См. раздел Email server settings.
1. На палитре Действия дважды щелкните или перетащите action Отправить из пакет Эл.

почта.
2. In the To address field and the optional Cc and Bcc fields, enter the email addresses of the

recipients.

Прим.:  The To address, Cc, and Bcc fields are not case-sensitive.

3. В поле Тема введите тему сообщения электронной почты.
4. Необязательно: Чтобы указать, следует ли прикрепить несколько файлов в виде списка или

создать переменную для хранения значений списка файлового объекта, выберите вкладку
Список или Переменная во Вложении.

Прим.:  Если при создании бот вложение включает символ «меньше» (<) в качестве
специального символа в пути к файлу, этот специальный символ будет удален после
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выполнения бот, поскольку операционная система Windows не поддерживает этот специальный
символ.

Вариант Описание

Список • Выберите вложение из местоположения:
• Файл Control Room. Enables you to

select an attachment that is available in a
folder.

• Профиль рабочего стола. Enables you
to select an attachment that is available on
your device.
Вы можете указать комбинацию
статического пути или строковую
переменную. Чтобы использовать как
строковую переменную, скопируйте
статический путь с рабочего стола
и создайте переменную типа string.
Введите имя Переменной и вставьте
путь к файлу в поле Значение по
умолчанию. Нажмите F2, чтобы
вставить значение пути к файлу.

• Переменная. Enables you to specify the
file variable that contains the location of
the attachment.

• Укажите путь, который вы хотите вложить,
в поле Значение. Щелкните Добавить,
чтобы вложить несколько файлов.

Переменная Позволяет указать список файловых объектов,
содержащих местоположение вложений.
Создайте новую переменную типа Список
с подтипом Файл и добавьте путь к
файлу в поле Значение по умолчанию
(необязательно). Вы можете выбрать файл
рабочего стола или Control room.

5. Необязательно: Select the Raise error if attachments are missing (desktop only) check box to
verify that you have attached a file and the attached file exists.

Вариант Результат

The Raise error if attachments are
missing (desktop only) check box is
selected

If a file is not attached, the email is not sent
and the бот encounters an error.

The Raise error if attachments are
missing (desktop only) check box is not
selected

The email is sent even if a file is not
attached.
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6. Выберите формат, который вы хотите использовать, из следующих вариантов:
Вариант Описание

Обычный текст Используйте обычный текст в теле сообщения
без эффектов форматирования, таких
как полужирный шрифт, курсив или
подчеркивание, и без специальных вариантов
оформления.

Код HTML Используйте сценарий HTML в теле письма,
если хотите, чтобы содержимое каждый раз
отображалось в определенном виде. Вы также
можете включить интерактивные элементы,
например ссылки.

Редактор дизайна HTML Используйте этот параметр для создания
и настройки макета и текста сообщения
электронной почты. Используйте панель
инструментов редактора для внесения
различных изменений в текст, например
применения полужирного шрифта, курсива и
других эффектов форматирования, вставки
ссылок, изменения шрифта и размера текста.
Содержимое можно скопировать из редактора
дизайна и вставлять его в другие окна.

7. Enter the content you want to send along with the email in the Message field.
The email will be appended to the message you have specified.

8. Необязательно: Select the Include Go Green message at the end of the email check box.
The Go Green message appends the following text to the bottom of the email body: Please
consider the environment before printing. Let's Go Green!
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9. Выберите вариант Сервер эл. почты, EWS или Outlook в списке Отправить сообщение
эл. почты через, чтобы указать, с помощью какой службы следует отправлять сообщения
электронной почты: Exchange Web Services (EWS), Microsoft Outlook или почтового сервера.
• Если вы выбрали параметр Outlook, предоставлять дополнительные сведения не требуется.

Прим.:  Multiple accounts are not supported on the local system. Set up only one account to
access mails using боты.

• Email server: For information about the host and port to be used for the various mail servers, see
Email server settings.
• From address Enter the email address.

Прим.:  If the mail server does not support sending an email using an alias email address, use
the same email ID in the From address as provided in the Username field while configuring
the mail server.

• Use secure connection (SSL/TLS): Select True or False, or insert a Boolean variable.
• Email server host: Enter the host you want to connect.

Прим.:  If you use the host Outlook.office365.com, there is a limit of 30 messages sent per
minute and 10,000 recipients per day.

• Email server port: Enter the port you want to use to establish the connection.
• My server requires authentication: Select True or False, or insert a Boolean variable.
• Authentication mode: Select the authentication type:

• Basic
• OAuth2 – Authorization code with PKCE

Depending on the authentication mode that you selected, you must specify the details in the
following fields as applicable.
• Username: Enter the username that you want to use to access the mail server.

For example, john.smith@myCompanyName.com
• Password: Enter the password for the username you provided.
• For Client ID, Tenant ID, Redirect URI, and Client secret fields, enter the information that

is provided for your account on your Azure portal.
• Email provider: Select your email service provider from the drop-down list.

• Outlook/Office365
If you select this option, then provide the Tenant ID.

• Gmail

For Username, Password, Tenant ID, Client ID, and Client secret fields, choose from
Credential, Variable, or Insecure string tab:
• Credential: Use a value available in the credential vault.
• Variable: Use a user-defined variable that stores the values.
• Insecure string: Manually enter a value.

• EWS Server:
• Exchange Version: Select the version that your organization is using:

• Exchange Server 2013
• Exchange2010_SP2
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• Exchange2010_SP1
• Exchange2010
• Exchange2007_SP1

• Azure cloud: Select the product that your organization is using:
• Azure Global: For customers of Microsoft 365 Commercial version

(login.microsoftonline.com)
• Azure US GCC High: For customers of Microsoft 365 Government version

(login.microsoftonline.us)

• Optional: Domain name:
• If you are an Office 365 customer and you leave this field blank, Рабочая область RPA uses

smtp.office365.com to connect to the server.
• If you are an Office 365 customer and you have entered a domain name in the username

field, you must enter smtp.office365.com in this field.
• If you are not an Office 365 customer, enter the domain name of your organization.

Otherwise, Рабочая область RPA uses the domain name you provided in the Username
field.

• Authentication mode: Select the authentication types:

Прим.:  From Automation 360 v.27 or later, the authorization type OAuth2-Silent
authentication mode is renamed to OAuth2-ROPC, and the OAuth2-Interactive
authentication mode is renamed to OAuth2-Implicit.

• Basic
• OAuth2-ROPC
• OAuth2-Implicit
• OAuth2 – Authorization code with PKCE
• OAuth2 – Client credentials

Depending on the authentication mode that you selected, you must specify the details in the
following fields as applicable.
• Username: Enter the username that you want to use to access the mail server.

For example, john.smith@myCompanyName.com
• Password: Enter the password for the username you provided.
• For Client ID, Tenant ID, Redirect URI, and Client secret fields, enter the information that

is provided for your account on your Azure portal.
• Test connection: Click Test connection to sign in to your account, accept the permissions

requested to authenticate, and establish a connection with the server.

Прим.:  When you perform desktop operation and click Test connection to sign in to your
account, then add this redirect URI: https://outlook.office365.com.

For Username, Password, Tenant ID, Client ID, and Client secret fields, choose from
Credential, Variable, or Insecure string tab:
• Credential: Use a value available in the credential vault.
• Variable: Use a user-defined variable that stores the values.
• Insecure string: Manually enter a value.
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10. Щелкните Сохранить.

Using the For each mail in mail box iterator
You must use certain Email actions within a Loop action. Use the For each mail in mail box iterator to
repeat a set of actions on all the emails within the specific parameters.
First, connect to the email server. Using Connect action for Эл. почта
When you establish a connection with Microsoft Outlook, email messages are processed from the shared
mailbox. Ensure that you have set up the shared mailbox in your Outlook application.

Прим.:  This feature is supported only for Outlook.

You must use the following Эл. почта actions within a loop:
• Change status
• Удалить
• Save attachments
• Save email

Сообщения эл. почты извлекаются в соответствии с порядком папок, указанных в поле «Входящие».
В пределах каждой папки извлекаемые сообщения эл. почты упорядочиваются по дате и времени
получения, в порядке, обратном порядку поступления. Кроме того, фильтры можно применить к
указанным ниже полям.
• Типы сообщений эл. почты: Все, Прочитанные и Непрочитанные
• Тема
• Из определенной папки
• От определенного отправителя
• Ранее даты, на дату или позднее даты получения

To use an Эл. почта action within a loop, follow these steps:
1. Double-click or drag the Loop action from the Loop пакет in the Действия palette.
2. Select the For each mail in mail box option from the Iterator list.
3. In the Session name field, enter the name of the session that you used to connect to the email

server in the Connect action.
4. In the ALL, READ, or UNREAD options, specify the type of email to retrieve from the email server.

Прим.:  For an email server that uses the POP3 protocol, all emails are retrieved.

© 2023 Automation Anywhere. All rights reserved.     1530



    Automation Anywhere - Сборка

5. Необязательно: Specify the folder from which you want to retrieve the emails.
• Microsoft Outlook and Yahoo: You can specify the name of the folder.

For example, Inbox, Sent, Inbox/Sales, Inbox/IT and so on. The Sales and IT folders in
this example are user-created folders and not available by default.

• Gmail:
• To retrieve emails from the default folders, you must use [Gmail]/FOLDER, except for the

Inbox folder.
For example, [Gmail]/Draft, [Gmail]/Important, [Gmail]/Trash, and so on.

• To retrieve emails from the folders you have created or the Inbox folder, you must specify the
folder names as they are.
For example, if you have created folders called Bank and Sports in your Gmail, specify Bank
and Sports without the [Gmail] prefix to retrieve emails from these folders.

6. Необязательно: In the When subject contains field, specify a value to retrieve emails containing
the value you specified in their subject.
You can enter multiple text separated by semi-colon. When you specify multiple text separated
by semi-colon, the emails are retrieved with any text or combination of text. For example,
[Subject]=[Automation Anywhere]: The filter searches and retrieves emails where subject text
includes Automation or Automation Anywhere.
To know about the behavior of the subject filter for package version 3.13.1-20220713-173156 and
later using Microsoft Outlook server or Email server, see How subject filter works when moving emails.

7. Необязательно: In the From specific senders field, specify the email addresses to retrieve the
emails.

8. Необязательно: In the When received date is on or after list, select an option to retrieve specific
emails on or after a certain date.

9. Необязательно: In the When received date is on or before list, select an option to retrieve
specific emails on or before a certain date.
If you have specified values for Steps 6 through 9, the system retrieves only those emails that
meet all the criteria. For example, if you specify Bank in Step 5, Statement in Step 6, and
abcbank@xyz.com in Step 7, the system retrieves emails from the Bank folder that contain
Statement in the subject and were received from the abcbank@xyz.com email address.

10. Choose one of the following options from Use local timezone
• True: The email received date and time is displayed in the local time zone.
• False: The email received date and time is displayed in the UTC time zone.
• Variable: Enter a Boolean variable.

11. Необязательно: In the Assign the current value to variable list, select or create a dictionary
variable.
The dictionary variable stores the properties of each email. Using dictionary variable for email properties.

12. Щелкните Сохранить.

Insert a Message Box action into the Loop container to print the subject of each email. Use the
following message body, substituting the generic variable name for the one you used in Step 10:
$dictionaryVar{emailSubject}$

Using dictionary variable for email properties
When you automate an email-related task, Рабочая область RPA retrieves various properties of an
email and stores the values of these properties in a dictionary variable. These properties are stored in a
dictionary variable when you use an email action within a loop action.
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Some of the email properties that Рабочая область RPA retrieves are its subject, recipients, senders,
message, and received date and time. The email properties are stored in a dictionary variable within the
following dictionary keys:

Email property Тип данных Описание

emailSubject Строка Retrieves the value of the email
subject.

emailFrom Строка Retrieves the email ID which
is received from. The from
address is what your recipients
will see.

emailTo Строка Retrieves the recipient's email
ID.

emailCc Строка Retrieves the recipient mail id
from the CC list.

emailBcc Строка Retrieves the recipient mail id
from the BCC list.

emailMessage Строка Retrieves the text from the
email body.

emailReceivedTime Строка Retrieves the time when the
email was received.

emailReceivedDate Строка Retrieves the date when the
email was received.

emailSentTime Строка Retrieves the time when the
email was sent.

emailSentDate Строка Retrieves the date when the
email was sent.

Прим.:  The email received and sent date and time are retrieved in the following format:
• Date: dd/MM/yyyy HH:mm:ss

Sample output: 22/09/2022 17:07:13
• Time: HH:mm:ss Z

Sample output: 17:07:13 +0900

The system automatically associates the properties of an email with the appropriate dictionary keys. You
can use the values stored in these dictionary keys in another task, store them in a database, or for any
other purpose. These keys are available in the system and you must use them as specified above. For
example, if you have created a dictionary variable 'Test' and want to display the subject and sender of
an email in a message prompt, you must enter Test{emailSubject} and Test{emailFrom} in the
appropriate fields.
If you press F2 to use a variable in a field, you must select Test from the Choose a variable list and
enter emailSubject in the Dictionary key field in the Insert a variable dialog box to store the
subject of an email in that field. Similarly, you can enter emailFrom in the Dictionary key field to use
the email address of the sender of an email in a field.
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The dictionary key variable is required for all email-related tasks you automate from Microsoft Outlook and
any mail server if you want to use the email properties. You can use the dictionary key variable for the
following Email actions:
• Change status
• Удалить
• Forward
• Reply
• Save attachments
• Save email

Прим.:  The time required to save an email varies based on the size of the attachments available in
that email.

How subject filter works when moving emails
In the Move allaction and the Loop action in the Эл. почта пакет, learn how the subject filter works in
order to move your emails from one folder to another in the email or Microsoft Outlook server.
You can use the keywords in the email subject field to filter emails. If keywords are added within quotes ,
the бот will look for an exact match of keywords in the subject field to filter and retrieve emails.

Outlook server

The following table explains how the subject filter works when the subject field contains single, multiple
texts, or multiple subjects separated by semi-colon.
• Single text

Результат Пример

With double quotes: Retrieves emails with
the exact subject text and is case-sensitive.

Пример. [Subject]=["Automation"]:
The filter retrieves emails where the subject
text includes “Automation” as an exact word.

Without double quotes: Retrieves emails
that have the similar text and is not case-
sensitive.

Пример. [Subject]=[Automation]: The
filter searches and retrieves emails where the
subject text includes Automation.

• Multiple text

Результат Пример

With double quotes: Retrieves emails with
the exact subject text and is case-sensitive.

Пример. [Subject]=["Automation
 Anywhere"]: The filter retrieves emails
where subject text includes “Automation
Anywhere” as an exact phrase.

Without double quotes: Retrieve emails
with any text or combination of text and is
not case-sensitive.

Пример. [Subject]=[Automation
 Anywhere]: The filter searches and
retrieves emails where subject text includes
Automation or Automation Anywhere.
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• Multiple subjects separated by semi-colon

Результат Пример

With double quotes:Retrieves emails with
the complete subject line that is an exact
match including the semicolon and double
quotation marks.

Пример. [Subject 1] =["Delivery
 Failure"];[Subject 2] =["Mail
 server not found"], separated by a
semicolon.
The filter retrieves emails with the subject
line as one string that is an exact match with
the semicolon, such as “Delivery Failure ; Mail
server not found”.

Without double quotes: Retrieve emails
with the complete subject line including the
semicolon.

Пример. [Subject 1]= ["Delivery
 Failure"];[Subject 2]= ["Mail
 server not found"], separated by a
semicolon.
The filter retrieves emails with the subject
line that includes text as one string with the
semicolon but is not an exact match, such
as: Delivery Failure ; Mail server not found or
delivery failure ; mail server not found.

Some with double quotes and some
without double quotes: Retrieve emails
with the complete subject line that is an exact
match including the semicolon.

Пример. [Subject 1]= [Delivery
 Failure];[Subject 2]= ["Mail
 server not found"], separated by a
semicolon.
The filter retrieves emails with the subject
line as one string that is an exact match with
the semicolon, such as: Delivery Failure ; Mail
server not found.

Сервер эл. почты

The following table explains how the subject filter works when the subject field contains single, multiple
texts, or multiple subjects separated by semi-colon.
• Single text

Результат Пример

With double quotes: Retrieves emails with
the exact subject text and is case-sensitive.

Пример. [Subject]=["Automation"]:
The filter retrieves emails where the subject
text includes “Automation” as an exact word.

Without double quotes: Retrieves emails
that have the similar text and is not case-
sensitive.

Пример. [Subject]=[Automation]: The
filter searches and retrieves emails where the
subject text includes Automation.
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• Multiple text

Результат Пример

With double quotes: Retrieves emails with
the exact subject text and is case-sensitive.

Пример. [Subject]=["Automation
 Anywhere"]: The filter retrieves emails
where subject text includes “Automation
Anywhere” as an exact phrase.

Without double quotes: Retrieve emails
with any text or combination of text and is
not case-sensitive.

Пример. [Subject]=[Automation
 Anywhere]: The filter searches and
retrieves emails where subject text includes
Automation or Automation Anywhere.

• Multiple subjects separated by semi-colon

Результат Пример

With double quotes:Retrieve emails for
each subject that is an exact match and is
case-sensitive.

Example: [Subject 1] =["Delivery
 Failure"];[Subject 2] =["Mail
 server not found"]

Individual subjects separated by a semicolon
with an exact match are searched. The
filter retrieves emails with the subject line
“Delivery Failure” and/or “Mail server not
found”.

Without double quotes: Retrieve emails for
each subject and is not case-sensitive.

Example: [Subject 1]= [Delivery
 Failure];[Subject 2]= [Mail
 server not found]

The filter retrieves emails that include the
subject line with text as Delivery Failure or
Mail server not found.

Some with double quotes and some
without double quotes: Retrieve emails
for each subject. Subjects within double
quotation marks are an exact match. Subjects
without double quotes are not case-sensitive.

Example: [Subject 1]= [Delivery
 Failure];[Subject 2] = ["Mail
 server not found"]

• For Subject 1, the filter searches and
retrieves emails that include the text in the
subject line.

• For Subject 2, the filter searches and
retrieve emails with the exact text in the
subject line.

Сервер EWS

The following table explains how the subject filter works when the subject field contains single or multiple
texts with, or without, double quotes.
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Тема сообщения эл. почты

Searched
with
keywords

move
email

move
email
(Include
space)

Move
email

"move
email"

"Move
email"

" move
email" (Include
space)

" Move
email" (Include
space)

move
email
test

переместитьemail

move
email

Да Да Да Да Да Да Да Да - -

move
email

- - - - - Да Да - - -

Move
email

Да Да Да Да Да Да Да Да - -

"move
email"

Да Да - Да - Да - Да - -

"Move
email"

- - Да - Да - Да - - -

" move
email"

- - - - - Да - - - -

" Move
email"

- - - - - - Да - - -

move
email
test

- - - - - - - Да - -

переместитьДа Да Да Да Да Да Да Да Да -

email Да Да Да Да Да Да Да Да - Да

email" - - - Да Да Да Да - - -

"move - - - Да Да - - - - -

Прим.:
• When you search with keywords such as move email, Move email, or move, the бот will look for

the keywords in the Subject field to filter and retrieve emails.
• When you search with keywords inside a pair of double quotation marks in the Subject field such

as "Move email", "Move email", "move, or email", the бот will look for an exact match of
keywords and is case-sensitive to filter and retrieve emails.

Обработчик ошибок пакет
If a бот encounters an error due to an abnormal condition or exceptions during execution, the normal
execution of the бот is hindered, and the бот fails to complete the task. The Обработчик ошибок пакет
contains actions that enable you to easily handle exceptions a бот encounters and transfers control to the
other actions within that бот.
The actions in the пакет enable you to separate the actions you want to use to perform a task from the
actions you want to use to handle an exception. Handling exceptions ensures that a бот completes a task
when it encounters an error and defines actions when an error occurs.
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The following image illustrates how бот execution works when you use and do not use error handling in
your task.

Действия в Обработчик ошибок пакет

пакет Обработчик ошибок включает в себя описанные ниже actions.

Действие Описание

Попробовать См. раздел Try action in Обработчик ошибок.

Выявить См. раздел Catch action in Обработчик ошибок.

Окончательно См. раздел Finally action in Обработчик ошибок.

Вызвать См. раздел Throw action in Обработчик ошибок.

How Обработчик ошибок handles exceptions

The following image illustrates the flow of actions of the Обработчик ошибок пакет when an external
error is encountered during бот execution.

The following image illustrates the flow of actions of the Обработчик ошибок пакет when an internal
error is encountered during бот execution.
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Пример. Using the actions in the Обработчик ошибок пакет

For example, if you have a бот that reads data from a Microsoft Excel file and stores it in a database. The
бот might encounter an error if the required file is not available or while updating a table in the database.
Use the following methods to handle the errors:
• Exception 1:

• The Microsoft Excel spreadsheet from which you want to extract data is not available.
• How to handle: Use another file that contains the same data.

• Exception 2:
• The table that you want to use to store the data is not available in the database.
• How to handle: Display a message that the required table is not available.

Based on this example, perform the following to handle the mentioned exceptions:
1. Place all the actions that are for reading the data from the Microsoft Excel spreadsheet and storing the

extracted data into a table in the database within the Try action.
2. Place the actions to run for the following exceptions within the Catch action:

a. Exception 1: Place the actions to use the alternate file that contains the same data.
b. Exception 2: Place the Message box action to display a relevant message.

3. Place the Database > Disconnect action to terminate the connection with the database within the
Finally action, which occurs regardless of the Try outcome.

Try action in Обработчик ошибок
Use the Try action in the Обработчик ошибок пакет to allow you to add actions for the бот to execute
these actions as usual.

Настройки

If the бот does not encounter any errors, execution continues to the Finally action if it exists. However, if
an error occurs, бот execution moves directly to the Catch action and does not complete the rest of the
actions inside the Try action.
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Catch action in Обработчик ошибок
Use the Catch action in the Обработчик ошибок пакет to take control of the бот execution when an error
occurs within a Try action.

Настройки

You can assign values for the error description and the line number to variables within the Catch action.
You can add additional actions within the Catch action to handle the error condition. These actions can
include an Эл. почта Send action (sending an email about the error), a Log to file action (logging
the error condition to a file), or a Экран Capture window to capture a screenshot of the window or
application when the error occurs.
If a Catch action is not present, the Try action, upon experiencing an error, will continue processing
actions listed after the Try action.
You can use the Try and Catch actions multiple times in a бот to handle various exceptions. This enables
you to run a different set of actions based on the exception encountered.
You can now ignore errors from actions inside the Catch block by using the Catch > On error, continue
with next action option. When you select the On error, continue with next action check box, even if
there is an error from an action in the Catch block, no exception is thrown and the бот ignores the error
and continues to the next action.

Прим.:  Это усовершенствование применяется ко всем вложенным actions в блоке Выявить .
Например, если у вас есть action Попробовать/Выявить внутри основного action Выявить и
установлен флажок в основном action Выявить, любая ошибка в ходе выполнения actions из
вложенного блока также будет игнорироваться.

Finally action in Обработчик ошибок
Use the Finally action in the Обработчик ошибок пакет to enable you to execute actions after Try and
Catch, regardless of whether an exception occurs or not.

Настройки

The Finally action is most useful in logging audit information or any action that must follow the end of the
Try and Catch actions.

Throw action in Обработчик ошибок
Use the Throw action in the Обработчик ошибок пакет to create an error condition, which will
immediately shift the бот execution to the Catch action.

Настройки

If a logical error occurs within a Try action, you can use the Throw action to create an error condition,
which will immediately shift the бот execution to the Catch action. You can edit the Throw action
properties to set the error message to be sent to the Catch action. Outside of a Try action, the Throw
action causes a standard error dialog box to be displayed, requiring a user to manually click the Close
button to dismiss it.
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Базовый Excel пакет
The Базовый Excel пакет contains actions that enable you to automate many of the repetitive tasks in
XLSX workbooks. You use these actions when Microsoft Excel is not available on the device that you want
to use to automate Microsoft Excel-related tasks.

Прим.:  The XLS and CSV formats are not supported and you cannot set a value in the XFD column of a
spreadsheet.

Important:  If you use different versions of the Базовый Excel пакет in a parent бот and a child бот, the
capability to share a session across боты is currently not supported. To share a session across parent and
child боты, ensure that you use the same version of the package in both the parent and child боты.

Важное замечание:  When you use Microsoft Excel Version 2208 and a бот tries to open an
unprotected macro, a security warning is displayed indicating that the macros are blocked as they are not
from a trusted source.
Подробнее см. в разделе «Macros from the internet will be blocked by default in Office».

Choosing the Excel пакет in Automation 360

Automation 360 includes пакеты to support three types of Microsoft Excel usage. For optimal results, use
the пакет that corresponds to the type of Excel that is available on the device you are running боты on.
• No Excel installed: If you do not have Microsoft Excel installed on the device on which you are

running боты to automate Excel-related processes, use the Базовый Excel пакет.
• Desktop Excel installed: If you have a desktop version of Microsoft Excel installed on your computer,

use the Расширенный Excel пакет in your боты.
• Online Office 365 Excel only: If you are using Microsoft Excel 365 on a web browser, use the Office

365 Excel пакет for automating tasks related to Excel.

Recommendation:  For any бот automation use case that cannot be fulfilled by the Базовый Excel
пакет, we recommend that you use the Расширенный Excel пакет. When you use that Базовый Excel
пакет, you might experience limitations because of the Apache POI API that the пакет uses. Because of
this, the Базовый Excel пакет has limited capability when compared to the Расширенный Excel пакет that
uses the MS API.

To learn more, search for the Automating Excel Workbooks course in Automation Anywhere University: RPA
Training and Certification (A-People login required).

Перед началом работы

Выполните указанные ниже actions в рамках пакет Базовый Excel из числа доступных actions.
1. Open the Microsoft Excel spreadsheet that you want to read data from using the Open action.

Прим.:  The Базовый Excel пакет supports files that are a maximum size of 30 MB.

You must associate the details of the file you want to use with a session name, and use the session
name in the other actions in the Базовый Excel пакет, so that you do not have to provide the details
of the file in those actions again.
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2. Use the different actions available in the Базовый Excel пакет to automate the Microsoft Excel-related
tasks.

3. After you have automated all the Microsoft Excel-related tasks, close the spreadsheet using the Close
action.

Действия в Базовый Excel пакет

пакет Базовый Excel включает в себя описанные ниже actions.

Действие Описание

Закрыть См. раздел Close action.

Удалить ячейки .
См. раздел Delete cells action.

Найти См. раздел Using Find action in Excel.

Получить адрес ячейки См. раздел Get cell address action.

Получить имя столбца См. раздел Get column name action.

Получить несколько
ячеек См. раздел Get multiple cells action.

Получить номер строки См. раздел Get row number action.

Получить одну ячейку
.
См. раздел Get single cell action.

Перейти к ячейке .
См. раздел Go to cell action.

Открыть See Using the Open action.

Заменить См. раздел Using the Replace action.

Сохранить книгу См. раздел Save workbook action.

Задать ячейку См. раздел Set cell action.

Переключиться на лист См. раздел Switch to sheet action.

Close action
The Close action in the Базовый Excel пакет enables you to close an excel spreadsheet and Save
changes when closing the file.
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Настройки

Closes the current workbook and provides an option to Save changes when closing the file.Enter the
name of the session used to open the workbook with the Open .

Прим.:  This action terminates the process for the session.

Delete cells action
The Delete cells action in the Базовый Excel package enables you to delete the Active cell or a Specific
cell from the current worksheet.

Настройки

• Select the Active cell or Specific cell option to specify whether to retrieve the values from the active
cell or a specific cell.

• Select the Shift cells left or Shift cells up option to specify whether to shift the cell one position to
the left or up after the cell is deleted.

• Select the Entire row or Entire column option to specify whether to delete the entire row or column
of the cell.

• Enter the name of the session used to open the workbook with the Open .

Get multiple cells action
The Get multiple cells action in the Базовый Excel package enables you to retrieve the values from cells in
a Microsoft Excel spreadsheet and stores them in a table variable.

Настройки

This action retrieves cell values as string data types. It supports Excel cell formats, including Number,
Percentage, Currency, Scientific, and Date. For example, a value from a cell of Currency formatting retains
the currency symbol when passed to a table or record variable.

Прим.:  You must convert the values to perform non-string operations.

• Select any of the following options from the Loop through field:

Вариант Действие

All rows: Enables you to retrieve the values from all the
rows.

Specific row: Enables you to retrieve the values from the
row you have specified in the From row and
to row fields.

Cell range: Enables you to retrieve the values from the
range of cells you have specified in the From
cell and to cell field.

• Enter the name of the session used to open the workbook with the Open .
• In the Get value to the variable (optional) field, create or insert an existing string variable.
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Get single cell action
The Get single cell action in the Базовый Excel package enables you to retrieve the values from a single
cell in a Microsoft Excel spreadsheet and stores them in a string variable .

Настройки

This  retrieves cell values as string data types. It supports Excel cell formats, including Number,
Percentage, Currency, Scientific, and Date. For example, a value from a cell of Currency formatting retains
the currency symbol when passed to a table or record variable.

Прим.:  You must convert the values to perform non-string operations.

• Select the Active cell or Specific cell option to specify whether to retrieve the values from the active
cell or a specific cell.

• Enter the name of the session used to open the workbook with the Open .
• In the Store cell contents to field, create or insert an existing string variable.

You can use the output value to
Example of using a conditional statement

.

Get cell address action
The Get cell address action in the Базовый Excel package enables you to retrieve the location of the active
cell and stores it to a string variable.

Настройки

• Enter the name of the session used to open the workbook with the Open .
• In the Save the active cell address in local variable field, create or insert an existing string

variable.

Get column name action
The Get column name action in the Базовый Excel package enables you to retrieve the letter value of the
column of the active or specific cell and store it to a string variable.

Настройки

• Select the Active cell or Specific cell option to specify whether to retrieve the column name from the
active cell or a specific cell.

• Enter the name of the session used to open the workbook with the Open .
• In the Save the column name into local variable field, create or insert an existing string variable.

Get row number action
The Get row number action in the Базовый Excel package enables you to retrieve the row number of the
active or specific cell and stores it to a string variable.

© 2023 Automation Anywhere. All rights reserved.     1543



    Automation Anywhere - Сборка

Настройки

• Select the Active cell or Specific cell option to specify whether to retrieve the row number from the
active cell or a specific cell.

• Enter the name of the session used to open the workbook with the Open .
• In the Save the row number into local variable field, create or insert an existing string variable.

Go to cell action
The Go to cell action in the Базовый Excel package enables you to select a specific cell in a Microsoft Excel
spreadsheet.

Настройки

• Select the Active cell or Specific cell option to specify which cell to select.
• Enter the name of the session used to open the workbook with the Open .

Using the Open action for Базовый Excel
Use the Open action to open a Microsoft Excel spreadsheet with .xlsx extension. This action enables you
to specify whether to open the spreadsheet in read-only mode or read-write mode, a password to open the
spreadsheet, and so on.
To open a Microsoft Excel spreadsheet, do the following:
1. Double-click or drag the Open action from the Excel basic пакет in the Actions palette.
2. Select from where you want to open the Microsoft Excel spreadsheet:

Прим.:  The Базовый Excel пакет supports files that are a maximum size of 30 MB.

• Control Room file: Enables you to open a file from the Control Room.
• Desktop file: Enables you to open a file from the device. This field also accepts the file path input

as a string variable or global value.
• Переменная. Enables you to open a file by specifying a file variable.

3. Select the Sheet contains a header check box if the Microsoft Excel spreadsheet contains a header
row.

4. Select the Specific sheet name option and specify the name of the sheet to activate when the
Microsoft Excel spreadsheet opens.

5. Select Read-only mode or Read-write mode to open the Microsoft Excel spreadsheet in read-only
or edit mode, respectively.

6. Select the Password is required check box if a password is required to open the Microsoft Excel
spreadsheet.

7. Select any of the following tabs to create an Excel session:
• Локальный сеанс Укажите имя сеанса, которое можно использовать только в текущем бот.
• Глобальный сеанс Specify a session name that can be used across multiple боты, such as

parent боты, child боты, and other child боты of the parent боты.
You can also use the Global session option to loop through each row in an Расширенный Excel
worksheet.

Прим.:  You can open an Excel worksheet by using the Global session option and use it across
multiple боты without having to share the session by using the Set session variable action.
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You can also close the session from the child бот when you are using the Global session option
and sharing the session across child боты.

Важное замечание:  If you close the session from the child бот and run the parent бот, then
in the parent бот, the actions that come after the child бот are not run, and the бот fails with an
error because the session has already been closed from the child бот.

• Переменная. Укажите переменную сеанса, которую можно применить для совместного
использования этого сеанса с другими дочерними боты.

Прим.:  При использовании нескольких электронных таблиц для автоматизации операции
необходимо использовать разные имена сеансов для каждой электронной таблицы. Если вы
хотите использовать одно и то же имя сеанса для автоматизации всех электронных таблиц, вы
должны сначала закрыть сеанс одной электронной таблицы, а затем использовать то же имя
сеанса для другой электронной таблицы.

8. Enter the name of the session in the Session name field.
9. Щелкните Сохранить.

Save workbook action
The Save workbook action in the Базовый Excel package enables you to save a Microsoft Excel
spreadsheet to a specified location.

Настройки

Enter the name of the session used to open the workbook with the Open .

Прим.:  When you open an excel file from the Control Room and make changes in the file, the updated
file does not save in the Control Room This action is supported only for Excel files opened from the
desktop.

Set cell action
The Set cell action in the Базовый Excel package enables you to set the value you have specified in a cell
in a Microsoft Excel spreadsheet.

Настройки

• Select the Active cell or Specific cell option to specify whether to set the value in the active cell or a
specific cell.

• Enter the cell value to set in the Value to set field.
• Enter the name of the session or variable used to open the workbook with the Openaction.

Switch to sheet action
The Switch to sheet action in the Базовый Excel package enables you to activate a specific worksheet.

Настройки

• Select to activate the worksheet by the Index value or worksheet Name.
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The index is the numeric value assigned to the worksheet.
• Enter the name of the session used to open the workbook with the Open .

Расширенный Excel пакет
The Расширенный Excel пакет contains actions that enable you to automate many of the repetitive tasks
when working with Microsoft Excel spreadsheets.
You can automate tasks related to the workbook, worksheet, rows, columns, and cell operations. You can
use these actions when Microsoft Excel is installed on the device that you want to use to automate the
Microsoft Excel-related tasks.

Прим.:
• The Excel file that you use from the Control Room is applicable only for the current бот session. If you

modify the file during бот execution, the updated file cannot be uploaded back to the Control Room
• If your current office installation is any of the following:

• Microsoft 365 Apps for Enterprise
• Office 2016, 2019, or 2021 (Consumer Version 2009 or later)

Then you do not need to install the Microsoft Access Database Engine as an additional component in
your system.
However, if you have both Microsoft 365 Apps and the Microsoft Access Database Engine are installed
on your system, then you can uninstall the Microsoft Access Database Engine and repair Microsoft 365
Apps.
Microsoft recommends that you do not install the Microsoft Access Database Engine driver separately
because both the Microsoft Access Database Engine 2016 and Microsoft 365 Apps use the same major
version identifier (16.0). To learn more about the Microsoft Access Database Engine driver installation
requirement, see Unable to use the Access ODBC or OLEDB provider

Важное замечание:  When you use Microsoft Excel Version 2208 and a бот tries to open an
unprotected macro, a security warning is displayed indicating that the macros are blocked as they are not
from a trusted source.
Подробнее см. в разделе «Macros from the internet will be blocked by default in Office».

Important:  If you use different versions of the Расширенный Excel пакет in a parent бот and a child
бот, the capability to share a session across боты is currently not supported. To share a session across
parent and child боты, ensure that you use the same version of the package in both the parent and child
боты.

Действия in the Расширенный Excel пакет support Microsoft Office 2016 through Microsoft Office 2019,
Microsoft Office 365, and the following file formats:
• .xls
• .xlsx
• .xlsb
• .xml
• .xlsm
• .txt
• .ods
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• .htm
• .html
• .mht
• .mhtml
• .slk
• .pdf

Важное замечание:
• For files with .ods extension, unless you specify the sheet name in the Specify sheet name field of

the Open action, the action always opens the .ods file with the first sheet as active, by default. If the
sheet name contains a space character, after you save and close the Excel sheet, the space character is
displayed as underscore.

• Files with the .htm, .html, .mht, and .mhtml extensions cannot be converted into PDF.
• Files with the .slk and .pdf extensions contain only a single sheet. The sheet cannot be renamed. If

you rename the sheet and save the Excel sheet, the sheet does not retain the new name.
• Files with .htm, .html, .mht, .mhtml, .slk, and .pdf extensions cannot retain passwords.
• You cannot run a macro in files with the .pdf extension.
• Примечание. Macro-enabled Excel applications with VBA using 32-bit and 64-bit code are not

supported. If you encounter a Compile error in hidden module error message when
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running a macro, then see the following image to add the VBA code manually in the Excel file

You can also use some of the actions with the .csv format. См. раздел CSV operations in Расширенный
Excel.
См. раздел Пример переноса данных из Excel в базу данных.

Choosing the Excel пакет in Automation 360

Automation 360 includes пакеты to support three types of Microsoft Excel usage. For optimal results, use
the пакет that corresponds to the type of Excel that is available on the device you are running боты on.
• No Excel installed: If you do not have Microsoft Excel installed on the device on which you are

running боты to automate Excel-related processes, use the Базовый Excel пакет.
• Desktop Excel installed: If you have a desktop version of Microsoft Excel installed on your computer,

use the Расширенный Excel пакет in your боты.
• Online Office 365 Excel only: If you are using Microsoft Excel 365 on a web browser, use the Office

365 Excel пакет for automating tasks related to Excel.
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Перед началом работы

Выполните указанные ниже actions в рамках пакет Расширенный Excel из числа доступных actions.
1. Open the Microsoft Excel spreadsheet that you want to use to automate the Microsoft Excel-

related tasks. Use the Open action to open the spreadsheet. См. раздел Using the Open action for
Расширенный Excel.

Прим.:  For files containing large data sets, use actions from the База данных пакет to automate
create, read, and update operations. См. раздел Использование action «Подключить» для базы
данных.

2. Use the different actions available in the Расширенный Excel пакет to automate the Microsoft Excel-
related tasks.

3. After you have automated all the Microsoft Excel-related tasks, close the spreadsheet using the Close
action.

Действия в Расширенный Excel пакет

The actions in the Расширенный Excel пакет enable you to perform the following operations:

Действие Описание

Cell operations Perform operations such as extracting data from cells, deleting values from
a cell, moving a cursor to a specific cell, and finding and replacing content.
См. раздел Cell operations in Расширенный Excel.

Row and column
operations

Perform operations such as inserting new rows and columns, and hiding
and unhiding rows and columns. См. раздел Row and column operations in
Расширенный Excel.

Table operations Perform operations such as sorting and filtering data in a table, inserting
and deleting columns, and getting the table range. См. раздел Table
operations in Расширенный Excel.

Workbook operations Perform operations such as opening a workbook, appending data,
protecting and unprotecting a workbook, and converting a Microsoft Excel
workbook to a PDF file. См. раздел Workbook operations in Расширенный
Excel.

Операции с листами Perform operations such as creating and deleting a worksheet, appending
data, and hiding and unhiding a worksheet. См. раздел Worksheet
operations in Расширенный Excel.

Example tasks:
• Example of transferring data from CSV file to Excel worksheet
• Example of using a conditional statement
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More resources

• Free Automation 360 бот examples for Excel from Bot Store:
• Merge Excel Sheets Example
• Convert XML to Excel
• Convert multiple Excel files to CSV files

• Tutorial on using Excel packages: Work with large Excel datasets in a bot
• Training course Automating Excel Workbooks - Automation Anywhere University: RPA Training and

Certification (A-People login required)

Задачи, связанные с данной
Using Find action in Excel
Use the Find action to find a particular string in a Microsoft Excel spreadsheet or a CSV file.

Workbook operations in Расширенный Excel
A workbook is a file that contains one or more worksheets. The Excel advanced package contains various
actions that you can use to automate workbook-related tasks.

Workbook actions in the Excel advanced package

Пакет Расширенный Excel включает следующие действия:

Действие Описание

Добавить книгу См. Append workbook action

Закрыть См. Close action

Преобразовать Excel
в PDF

См. Convert excel to PDF action

Создать книгу См. Create workbook action

Открыть См. раздел Using the Open action for Расширенный Excel.

Защитить книгу См. Protect workbook action

Сохранить книгу См. Save workbook action

Отключить защиту
книги

См. Unprotect workbook action

Append workbook action
The Append workbook action in the Расширенный Excel пакет enables you to add all the worksheets from
the specified workbook to the end of the currently open workbook.

Настройки

• Enter the name of the session used to open the workbook with the Open .
• Specify the workbook from which you want to append the worksheets in the Append from workbook

field.
• If the workbook is protected, select the Password is required check box and enter the password in

the To open field.
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• In the To open field, provide your password with one of the following options:
• Учетные данные. Select a credential from the . Credentials and credential variables in the Bot editor
• Переменная. Select a variable holding a credential data type value. Your variables (user-defined)
• Insecure string: Enter a value or select a variable.

Важное замечание:  Values entered using this option are not encrypted.

Close action
The Close action in the Расширенный Excel пакет enables you to close the current workbook and provide
an option to save changes when closing the file.

Настройки

Enter the name of the session used to open the workbook with the Open .
Convert excel to PDF action
The Convert excel to PDF action of the Расширенный Excel пакет enables you to convert the entire
workbook, specific worksheets in a workbook, or a CSV file to a PDF file.

Настройки

• Enter the name of the session used to open the workbook with the Open .
• Specify whether you want to convert the Entire excel file, Active sheet, or Specific sheet to a PDF

file.
• Enter a name for the PDF file in the Select PDF file name field.
• Specify the location where you want to save the file in the Select PDF storage location field.

Create workbook action
The Create workbook action of the Расширенный Excel пакет enables you to create a Microsoft Excel
workbook or a CSV file.

Настройки

• Enter the name of the session used to open the workbook with the Open .
• Specify the location where you want to save the workbook in the File path field.
• Specify the name of the worksheet in the Sheet name field.
• Specify the passwords to open and edit the workbook in the Password to open and Password to

edit fields. Provide your password with one of the following options:
• Учетные данные. Select a credential from the . Credentials and credential variables in the Bot editor
• Переменная. Select a variable holding a credential data type value. Your variables (user-defined)
• Insecure string: Enter a value or select a variable.

Важное замечание:  Values entered using this option are not encrypted.
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• Select any of the following tabs to create an Excel session:
• Локальный сеанс Укажите имя сеанса, которое можно использовать только в текущем бот.
• Глобальный сеанс Укажите имя сеанса, которое можно использовать для нескольких боты,

например родительских боты, дочерних боты и других дочерних боты родительских боты.
You can also use the Global session option to loop through each row in an Расширенный Excel
worksheet.

Прим.:  You can open an Excel worksheet by using the Global session option and use it across
multiple боты without having to share the session by using the Set session variable action.

You can also close the session from the child бот when you are using the Global session option
and sharing the session across child боты.

Важное замечание:  If you close the session from the child бот and run the parent бот, then in
the parent бот, the actions that come after the child бот are not run, and the бот fails with an error
because the session has already been closed from the child бот.

• Переменная. Укажите переменную сеанса, которую можно применить для совместного
использования этого сеанса с другими дочерними боты.

Прим.:  If the Microsoft sensitivity label feature is enabled for Office 365 Excel application, see
Automation Anywhere interaction with Microsoft Labels (A-people login required)

Using the Open action for Расширенный Excel
Use the Open action to open a Microsoft Excel spreadsheet or a CSV file. This action enables you to
specify whether to open the spreadsheet in read-only mode or read-write mode, a password to open the
spreadsheet, and so on.
When you use the Open action to open a macro-enabled Excel workbook of .xlsm format, the Auto_Open
VBA procedure does not run automatically because the VBA procedure runs only when the Excel workbook
is opened manually. This is a default behavior of Microsoft Excel. См. раздел Behavior difference between
Workbook_Open and Auto_Open procedure.

Прим.:  You can use wildcard pattern based search to open an existing excel file that matches the search
criteria. For example, if you have multiple files with similar names such as table1.xlsx, table2.xlsx,
table3.xlsx, you can open the file by specifying the (*) wildcards in the file path as table*.xlsx to
open the first file that matches the pattern.

1. Double-click or drag the Open action from the Excel advanced пакет in the Actions palette.
2. Select from where you want to open the Microsoft Excel spreadsheet:

• File: Select one of the following options to open a Microsoft Excel spreadsheet:
• Control Room file: Enables you to open a file from the Control Room.
• Desktop file: Enables you to open a file from the device. This field also accepts the file path

input as a string variable or global value.

Прим.:  In the Desktop file field, if you enter a file path or browse to a particular file from
the system and if the file path is separated by the backslash (\) characters, when you save the
бот, the backslash characters are changed to slash (/) characters because the бот uses slash
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characters to separate file paths. Your боты continue to run successfully even if the backslash
characters are is changed to slash characters during бот run.

• Переменная. Enables you to open a file by specifying a file variable.

• SharePoint: In the File path field, enter the exact file path of the Excel spreadsheet on
SharePoint. To copy the URL of the Excel spreadsheet from SharePoint, perform the following
steps:
• Open the Microsoft Excel spreadsheet on SharePoint.
• In the Microsoft Excel spreadsheet, navigate to File > Info.
• Click Copy path.

3. Select the Sheet contains a header check box if the Microsoft Excel spreadsheet contains a header
row.

4. Select the Specific sheet name option and specify the name of the sheet to activate when the
Microsoft Excel spreadsheet opens.

5. Select Read-only mode or Read-write mode to open the Microsoft Excel spreadsheet in read-only
or edit mode respectively.

6. Select the Password is required check box if a password is required to open or edit the Microsoft
Excel spreadsheet.

7. Select the Load Add-ins check box if you want to load the add-ins available in the Microsoft Excel
spreadsheet.

8. Select the Exclude hidden sheets check box if you want to ignore the excel sheets that are hidden
and do not want to perform any operation on those hidden sheets.

9. Select any of the following tabs to create an Excel session:
• Локальный сеанс Укажите имя сеанса, которое можно использовать только в текущем бот.
• Глобальный сеанс Specify a session name that can be used across multiple боты, such as

parent боты, child боты, and other child боты of the parent боты.
You can also use the Global session option to loop through each row in an Расширенный Excel
worksheet.

Прим.:  You can open an Excel worksheet by using the Global session option and use it across
multiple боты without having to share the session by using the Set session variable action.

You can also close the session from the child бот when you are using the Global session option
and sharing the session across child боты.

Важное замечание:  If you close the session from the child бот and run the parent бот, then
in the parent бот, the actions that come after the child бот are not run, and the бот fails with an
error because the session has already been closed from the child бот.

• Переменная. Укажите переменную сеанса, которую можно применить для совместного
использования этого сеанса с другими дочерними боты.

Прим.:  При использовании нескольких электронных таблиц для автоматизации операции
необходимо использовать разные имена сеансов для каждой электронной таблицы. Если вы
хотите использовать одно и то же имя сеанса для автоматизации всех электронных таблиц, вы
должны сначала закрыть сеанс одной электронной таблицы, а затем использовать то же имя
сеанса для другой электронной таблицы.

10. Щелкните Сохранить.
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Protect workbook action
The Protect workbook action of the Расширенный Excel пакет enables you to protect the workbook and
its structure using a password. Protecting a workbook prevents other users from opening the workbook
without the password, and protecting the structure of a workbook prevents other users from adding,
moving, deleting, hiding, and renaming worksheets within that workbook.

Настройки

• Enter the name of the session used to open the workbook with the Open .
• Select the Protect workbook and Protect workbook structure check boxes and provide a

password in the respective fields.

Save workbook action
The Save workbook action of the Расширенный Excel пакет enables you to save the current workbook.

Настройки

Enter the name of the session used to open the current workbook with the Open action.

Прим.:  When you open an Excel file from the Control Room and make changes to the file, the updated
file is not saved in the Control Room. This action is supported only for Excel files opened from the desktop.

Unprotect workbook action
The Unprotect workbook action of the Расширенный Excel пакет enables you to unprotect a workbook
and its structure. Unprotecting a workbook removes the restriction applied on opening the workbook, and
unprotecting the structure of a workbook removes the restriction applied on modifying the structure of the
workbook. Unprotecting allows other users to open the workbook, add, move, delete, hide, and rename
worksheets within the workbook.

Настройки

• Enter the name of the session used to open the workbook with the Open .
• Select the Unprotect workbook and Unprotect workbook structure check boxes and provide a

password to unprotect the workbook structure.

Worksheet operations in Расширенный Excel
Пакет Расширенный Excel содержит различные действия, которые можно использовать для
автоматизации задач, связанных с листами.

Действия с листами в пакете Расширенный Excel

Пакет Расширенный Excel включает следующие действия:

Действие Описание

Получить доступ к листу,
защищённому паролем

См. Access password protected worksheet action

Добавить лист См. раздел Using Append worksheet action.

Создать лист См. Create worksheet action
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Действие Описание

Удалить лист См. Delete worksheet action

Отключить или включить
обновление экрана в
реальном времени

См. Disable or enable real-time screen update action

Получить имя текущего
листа

См. Get current worksheet name action

Получить лист как
таблицу данных

См. Get worksheet as data table action

Получить имена листов См. Get worksheet names action

Скрыть лист См. Hide worksheet action

Защитить лист паролем См. Password protect worksheet action

Переименовать лист См. Rename worksheet action

Получить число листов См. Retrieve sheets count action

Выполнить макрос See Run macro action

Переключиться на лист См. Switch to sheet action

Показать все листы См. Unhide all worksheets action

Показать лист См. Unhide worksheet action

Записать из таблицы
данных

См. Write from data table action

Access password protected worksheet action
The Access password protected worksheet action of the Расширенный Excel пакет enables you to access
a password-protected worksheet in the current workbook.

Настройки

• Enter the name of the session used to open the workbook with the Open .
• Введите пароль для доступа к листу.

Using Append worksheet action
Use the Append worksheet action to append a worksheet from another workbook to the current
workbook.

Прим.:  If the current workbook already has a worksheet with the same name, you must rename the
worksheet being appended.

To append a worksheet, do the following:
1. Double-click or drag the Append worksheet action from the Excel node in the Actions palette.
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2. Select an option to specify the location of the spreadsheet from which you want to append the
worksheet:
• From 'My боты': Enables you to open a Microsoft Excel spreadsheet from an existing бот.
• From local device: Enables you to open a Microsoft Excel spreadsheet from a local device.
• Select an existing file variable: Enables you to open a Microsoft Excel spreadsheet using a file

variable.

3. Select the Password is required option if the Microsoft Excel spreadsheet requires a password to
open it.

4. Необязательно: In the User password or Owner password field, enter a password to restrict
access to the encrypted PDF file.
• User password: Allow users to perform specific operations on the encrypted PDF file.
• Owner password: Allow users to use a password to open the file.

5. Select the Enter worksheet name or Enter worksheet index option to specify the name or
number of the worksheet that you want to append.

6. Enter the name of the session used to open the workbook with the Open .
7. Щелкните Сохранить.

Create worksheet action
The Create worksheet action of the Расширенный Excel пакет enables you to create a worksheet in the
current workbook.

Настройки

• Enter the name of the session used to open the workbook with the Open .
• Укажите для листа номер индекса в поле Лист по индексу или имя в поле Лист по имени. The

index number is the number assigned to a worksheet. For example, if you want to perform an operation
on the worksheet at the third position in the workbook, enter 3 in the field.

Delete worksheet action
The Delete worksheet action of the Расширенный Excel пакет enables you to delete a spreadsheet from
the current workbook.

Настройки

• Enter the name of the session used to open the workbook with the Open .
• Укажите для листа номер индекса в поле Лист по индексу или имя в поле Лист по имени. The

index number is the number assigned to a worksheet. For example, if you want to perform an operation
on the worksheet at the third position in the workbook, enter 3 in the field.

Прим.:  Вы можете удалить лист, только если книга содержит более одного листа.

Disable or enable real-time screen update action
The Disable or enable real-time screen update action of the Расширенный Excel пакет enables you to
disable the real-time screen update.
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Настройки

• Выберите Отключить, чтобы отключить обновление экрана в реальном времени при
выполнении actions на листе Microsoft Excel с большими наборами данных.

• Выберите Включить, чтобы снова включить обновление экрана в реальном времени для других,
последующих actions.

• Приложите action, у которого есть проблемы с производительностью в рамках action Отключить
или включить обновление экрана в реальном времени.
Например, если при использовании action Запустить макрос для запуска макроса на листе с
большими наборами данных вы столкнулись с проблемами производительности, используйте
action Отключить или включить обновление экрана в реальном времени перед action
Запустить макрос и выберите Отключить для отключения обновления экрана в реальном
времени для повышения производительности. Используйте action Отключить или включить
обновление экрана в реальном времени еще раз после action Запустить макрос и
выберите Включить для повторного включения обновления экрана в реальном времени для
других, последующих actions.

Важное замечание:  Мы рекомендуем использовать это action только в том случае, если вы
столкнулись с проблемами производительности при выполнении actions с большими наборами
данных.

Get current worksheet name action
The Get current worksheet name action of the Расширенный Excel пакет enables you to get the name of
the current worksheet and assign it to a string variable.

Настройки

• Enter the name of the session used to open the workbook with the Open .
• Select a string variable that you want to use to store the name of the worksheet from the Assign the

output to variable list. В  отображается описательное имя переменной по умолчанию. If you
create several output variables, subsequent variable names are appended with a -1, -2, -3, and so on
to avoid duplication.

Get worksheet as data table action
Thet Get worksheet as data table action of the Расширенный Excel пакет enables you to get data from a
worksheet and save it to a table variable.

Настройки

• Укажите для листа номер индекса в поле Лист по индексу или имя в поле Лист по имени. The
index number is the number assigned to a worksheet. For example, if you want to perform an operation
on the worksheet at the third position in the workbook, enter 3 in the field.

• Выберите параметр Прочитать для чтения видимого текста или значения ячейки.
Например, если ячейка содержит значение 70%, параметр Прочитать значение ячейки
прочитает значение как 70, игнорируя формат %, в то время как Прочитать видимый текст
прочитает содержимое как 70%.

Recommendation:  Используйте параметр Прочитать значение ячейки, так как чтение
значения из ячейки обеспечивает лучшую производительность, чем чтение видимого текста.

• Enter the name of the session used to open the workbook with the Open .
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• Select a table variable that you want to use to store the data from the worksheet from the Assign
value to the variable list. В  отображается описательное имя переменной по умолчанию. If you
create several output variables, subsequent variable names are appended with a -1, -2, -3, and so on
to avoid duplication.

Get worksheet names action
The Get worksheet names action of the Excel advanced пакет enables you to get the names of all the
worksheets and assign them to a list variable of string data type.

Настройки

• Enter the name of the session used to open the workbook with the Open .
• Select a string variable that you want to use to store the name of the worksheet from the Assign the

output to variable list. В  отображается описательное имя переменной по умолчанию. If you
create several output variables, subsequent variable names are appended with a -1, -2, -3, and so on
to avoid duplication.

Hide worksheet action
The Hide worksheet action of the Расширенный Excel пакет enables you to hide a worksheet from the
current workbook.

Настройки

• Укажите имя листа, который требуется скрыть в поле Введите имя листа, который требуется
скрыть.

Прим.:  Вы можете скрыть лист, только если книга содержит более одного листа.

• Enter the name of the session used to open the workbook with the Open .

Password protect worksheet action
The Password protect worksheet action of the Расширенный Excel пакет enables you to protect a
worksheet with a password. Вы также можете указать операции, которые следует ограничить на
листе.

Настройки

• Укажите пароль, который вы хотите использовать для защиты листа, и установите флажки для
операций, которые вы хотите ограничить на листе. Например, установите флажки Удалить
строку и Удалить столбец, чтобы ограничить удаление пользователем строк или столбцов из
листа.

• Enter the name of the session used to open the workbook with the Open .

Rename worksheet action
The Rename worksheet action of the Расширенный Excel пакет enables you to rename a worksheet in the
current workbook.
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Настройки

• Укажите номер индекса или имя листа, который нужно переименовать в поле Лист по индексу
или Лист по имени.
Номер индекса — это номер, присвоенный листу. Например, если вы хотите выполнить операцию
на листе, находящимся на третьей позиции в книге, введите в поле значение 3.

Прим.:  Вы не можете переименовать лист, если лист с таким же именем уже существует в
книге.

• Введите новое имя листа, содержащее менее 31 символа.
• Enter the name of the session used to open the workbook with the Open .

Retrieve sheets count action
The Retrieve sheets count action of the Расширенный Excel пакет enables you to get the number of
sheets available in the current workbook and store it in a number variable.

Настройки

• Выберите соответствующий параметр, чтобы указать, включать ли скрытый лист или нет, и
присвоить число переменной.

• Enter the name of the session used to open the workbook with the Open .
• Select a number variable that you want to use to store the name of the worksheet from the Select the

variable to assign to list. В  отображается описательное имя переменной по умолчанию. If you
create several output variables, subsequent variable names are appended with a -1, -2, -3, and so on
to avoid duplication.

Run macro action
The Run macro action in the Расширенный Excel package enables you to run macros in a worksheet.

Настройки

• Укажите имя макроса, который вы хотите выполнить, и его аргументы.
• Enter the name of the session used to open the workbook with the Open .

Прим.:
• When you write a macro code, always end the code by adding Exit Sub.
• If you add End to terminate the macro, then on execution, the бот can fail with an error.
• Ensure that a macro code contains only one instance of the End or End Sub statement in the macro

code to terminate the macro. If there is more than one instance of the statement, then on execution,
the бот might fail with an error.

Пример.

Public Sub main()
MsgBox "Hello”
MsgBox “Hello2”
End Sub
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Switch to sheet action
The Switch to sheet action in the Расширенный Excel package activates a particular sheet in a Microsoft
Excel file.

Настройки

• Укажите, следует ли активировать Лист по индексу (числовое значение) или Лист по имени.
• Enter the name of the session used to open the workbook with the Open .

Прим.:  бот, содержащий действие Переключиться на лист, переключается на скрытый лист и
выполняет операции на нем. После завершения операций лист остается скрытым и не активируется.

Unhide all worksheets action
The Unhides all worksheets action in the Расширенный Excel package unhides all the worksheets in the
current workbook.

Настройки

Показывает все листы в текущей книге. Введите имя сеанса, используемого для открытия текущей
книги с использованием действия Открыть.
Unhide worksheet action
The Unhide worksheet action in the Расширенный Excel package unhides a specific worksheet in the
current workbook.

Настройки

• Введите имя листа, который необходимо показать.
• Enter the name of the session used to open the workbook with the Open .

Write from data table action
The Write from data table action in the Расширенный Excel package enables you to write values from a
data table into a worksheet.

Настройки

• Укажите переменную таблицы данных, которая содержит данные, которые вы хотите записать в
лист.

• Укажите, нужно ли записать данные в текущий Активный лист или Определенный лист.
• Укажите адрес ячейки, которую вы хотите использовать в качестве начальной точки данных в

поле Укажите первую ячейку.
• Enter the name of the session used to open the workbook with the Open .

Row and column operations in Расширенный Excel
The Excel advanced package contains various actions that you can use to automate tasks related to the
row and column operations in a Microsoft Excel spreadsheet.
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Row and column actions in the Excel advanced package

Пакет Расширенный Excel включает следующие действия:

Действие Описание

Получить имя столбца См. Get column name action

Получить номер строки См. Get row number action

Скрыть строки/столбцы
в выделении

См. Hide rows/columns in selection action

Insert/Delete Rows/
Columns

См. раздел Using Insert or Delete actions for rows and columns.

Прочитать столбец См. Read column action

Прочитать строку См. Read row action

Удалить пустые строки См. Remove blank rows action

Select cell(s)/row(s)/
column(s)

См. раздел Using Select action for cells, rows, and columns.

Unhides rows/columns
in selection

См. Unhides rows/columns in selection action

Get column name action
The Get column name in the Расширенный Excel package enables you to retrieve the column name that
contains the specific cell and stores it to a string variable. This action supports .xlsx and .xlxm files.

Настройки

• Select the Active cell or Specific cell option to specify the cell location.
• Enter the name of the session used to open the workbook with the Open .
• Select a string variable from the Save the column name to variable list. В  отображается

описательное имя переменной по умолчанию. If you create several output variables, subsequent
variable names are appended with a -1, -2, -3, and so on to avoid duplication.

Get row number action
The Get row number action in the Расширенный Excel package enables you to retrieve the row number
that contains the specific cell and stores it to a string variable. This action supports .xlsx and .xlxm files.

Настройки

This action supports .xlsx and .xlxm files.
• Select the Active cell or Specific cell option to specify the cell location.
• Enter the name of the session used to open the workbook with the Open .
• Select a string variable from the Save the row number to variable list. В  отображается

описательное имя переменной по умолчанию. If you create several output variables, subsequent
variable names are appended with a -1, -2, -3, and so on to avoid duplication.
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Hide rows/columns in selection action
The Hide row/columns in selection action in the Расширенный Excel package enables you to hide rows or
columns in the current worksheet.

Настройки

• Select the appropriate option to specify whether to hide one or more rows and columns.
• Enter the name of the session used to open the workbook with the Open .

Using Insert or Delete actions for rows and columns
Use the Insert or Delete actions to create or remove rows or columns from the current worksheet or CSV
file.
To change the name or value of an Active cell or a Specified cell in a Microsoft Excel spreadsheet or a
CSV file in a row or a column, see Set cell.
To insert or delete rows or columns in a worksheet, do the following:
1. Double-click or drag the Insert or Delete action from the Excel node in the Actions palette.
2. Select the Row operations if you want to insert or delete rows from the spreadsheet.

a) Select the Insert Row at option to insert a row and specify the location where you want to
insert the row in the field.

b) Select the Delete Row(s) at option to delete rows. You must specify the row number you want
to delete in the field. For example, if you want to delete the tenth row in the worksheet, you must
enter 10 in the field. If you want to delete the first five rows, you must enter 1:5 in the field.

3. Select the Column operations if you want to insert or delete columns from the spreadsheet.
a) Select the Insert Column at option to insert a column and specify the location where you want

to insert the column in the field.
b) Select the Delete Column(s) at option to delete columns. You must specify the address of

the column you want to delete in the field. For example, if you want to delete column 'D' in the
worksheet, you must enter D in the field. If you want to delete the first five columns, you must
enter A:E in the field.

4. Enter the name of the session used to open the workbook with the Open .
5. Щелкните Сохранить.

Read column action
The Read column action in the Расширенный Excel package enables you to extract data from a column
and stores it in a list variable of string data type.

Настройки

• Select the From active cell or From specific cell option to specify the starting point. You can also
select the Read full column option to extract data for the entire column.
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• Выберите параметр Прочитать для чтения видимого текста или значения ячейки.
Например, если ячейка содержит значение 70%, параметр Прочитать значение ячейки
прочитает значение как 70, игнорируя формат %, в то время как Прочитать видимый текст
прочитает содержимое как 70%.

Recommendation:  Use the Read cell value option as reading value from a cell for better
performance than reading visible text.

• Enter the name of the session used to open the workbook with the Open .
• Select a table variable to store the extracted values.

Прим.:  This action overwrites any existing values in the selected table.

В  отображается описательное имя переменной по умолчанию. If you create several output
variables, subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

Read row action
The Read row action in the Расширенный Excel package enables you to extract data from a row and
stores it in a list variable of string data type.

Настройки

Extracts data from a row and stores it in a list variable of string data type.
• Select the From active cell or From specific cell option to specify the starting point. You can also

select the Read full row option to extract data for the entire row.
• Выберите параметр Прочитать для чтения видимого текста или значения ячейки.

Например, если ячейка содержит значение 70%, параметр Прочитать значение ячейки
прочитает значение как 70, игнорируя формат %, в то время как Прочитать видимый текст
прочитает содержимое как 70%.

Recommendation:  Используйте параметр Прочитать значение ячейки, так как чтение
значения из ячейки обеспечивает лучшую производительность, чем чтение видимого текста.

• Enter the name of the session used to open the workbook with the Open .
• Select a list variable of string data type that you want to use to store the extracted values. В 

отображается описательное имя переменной по умолчанию. If you create several output variables,
subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

Remove blank rows action
The Remove blank rows action in the Расширенный Excel package enables you to remove blank rows from
the current worksheet.

Настройки

You can specify the range from which you want to delete the blank rows.
Using Select action for cells, rows, and columns
Use the Select action to select cells, rows, or columns.
To select cells, rows, or columns do the following:
1. Double-click or drag the Select cell, row, or column action from the Excel node in the Actions

palette.
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2. Select an option from the Select list to specify whether you want to select a cell, row, or column.
a) If you have selected the Cell option, select any of the following options:

• Active cell: Enables you to select the active cell from the worksheet.
• Specific cell: Enables you to select the cell you have specified in the field.
• Cell range: Enables you to select all the cells in the range you have specified in the field.
• All cells in the sheet: Enables you to select all the cells in the worksheet.

b) If you have selected the Column option, select any of the following options:
• Column of active cell: Selects the column of the current active cell in the worksheet.
• Specific column: Enables you to select the column you have specified in the field.
• Column range: Enables you to select all the columns in the range you have specified in the

field.

c) If you have selected the Row option, select any of the following options:
• Row of active cell: Selects the row of the current active cell in the worksheet.
• Specific row: Enables you to select the row you have specified in the field.
• Row range: Enables you to select all the rows in the range you have specified in the field.

3. Enter the name of the session used to open the workbook with the Open .
4. Щелкните Сохранить.

Unhides rows/columns in selection action
The Unhide rows/columns in selection action in Расширенный Excel package enables you to unhide the
hidden rows or columns in the current worksheet.

Настройки

• Select the appropriate option to specify whether you want to unhide a row or column and which row or
column to unhide.

• Enter the name of the session used to open the workbook with the Open .

Cell operations in Расширенный Excel
The Excel advanced package contains various actions that you can use to automate tasks related to cell
operations.

Cell actions in the Excel advanced package

Пакет Расширенный Excel включает следующие действия:

Действие Описание

Удалить ячейки См. Delete cells action

Найти следующую
пустую ячейку

См. раздел Using Find next empty cell action.

Найти См. раздел Using Find action in Excel.

Получить адрес ячейки См. Using the Get cell address action
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Действие Описание

Получить цвет ячейки См. раздел Using Get cell color action.

Получить несколько
ячеек

См. Get multiple cells action

Получить число строк См. раздел Using Get number of rows action.

Получить одну ячейку См. Get single cell action

Перейти к ячейке См. Go to cell action

Перейти к следующей
пустой ячейке

См. Go to next empty cell action

Прочитать формулу
ячейки

См. Read cell formula action

Заменить См. раздел Using the Replace action.

Задать ячейку См. Set cell action

Задать формулу ячейки См. Set cell formula action

Delete cells action
The Delete cell action in the Расширенный Excel package enables you to delete the Active cell or a
Specific cell from the current worksheet or a CSV file.

Настройки

Прим.:  You can enter a cell range in the Specific - cell field using the starting - cell:ending
 cell format. For example, to perform this operation on all cells in the second row and from the first
through third column, enter A2:C2.

After deleting the cell, you can:
• Shift cells left: Deletes the specified cell and shifts the cell one position to the left.
• Shift cells up: Deletes the specified cell and shifts the cell one position up.
• Entire row: Deletes the entire row that contains the cell you have specified to delete.
• Entire column: Deletes the entire column that contains the cell you have specified to delete.

Using Find next empty cell action
Use the Find next empty cell action to find the next empty cell in the current worksheet.
To find the next empty cell, do the following:
1. Double-click or drag the Find next empty cell action from the Excel node in the Actions palette.
2. Select the row or column option from the Traverse by section to specify whether you want to find

the empty cell in a row or column.
3. Select the active cell or specific cell option from the Start from section to specify the point from

where you want to start the search.
4. Select the string variable you want to use to store the address of the empty cell from the Assign the

output to variable list.
В  отображается описательное имя переменной по умолчанию. If you create several output
variables, subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

5. Enter the name of the session used to open the workbook with the Open .
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6. Щелкните Сохранить.

Using Find action in Excel
Use the Find action to find a particular string in a Microsoft Excel spreadsheet or a CSV file.
To find a value in a Microsoft Excel spreadsheet, do the following:
1. Double-click or drag the Find action from the Excel node in the Actions palette.
2. Select an option from the From list to specify a starting point of the cell range for search:

• Beginning: Starts the search from the beginning of the spreadsheet.
• End: Starts the search from the end of the spreadsheet.
• Active cell: Starts the search from the active cell in the spreadsheet.
• Specific cell: Enables you to specify the address of the cell from where you want to start the

search.

3. Select an option from the Till list to specify an end point of the cell range for search:
• Beginning: Ends the search at the beginning of the spreadsheet.
• End: Ends the search at the end of the spreadsheet.
• Active cell: Ends the search at the active cell in the spreadsheet.
• Specific cell: Enables you to specify the address of the cell where you want to end the search.

4. Specify the string you want to search for in the Find field.
5. Select from the following search options:

• By rows: Enables you to search by rows.
• By columns: Enables you to search by columns.
• С учетом регистра. Only performs this action on cells that contain a string that matches the

uppercase and lowercase characters of the string you specified in the Find field.
• Match entire cell contents: Enables you to find only those cells that contain the entire string

you have specified in the Find field.

6. Enter the name of the session used to open the workbook with the Open .
7. Select the list variable of string data type that you want to use to store the output from the Assign

cell addresses to variable list.
8. Щелкните Сохранить.

When you search for a value using the Find action, it will either return a list of cell addresses that contain
the value or will return an empty list if the value is not found.
Using the Get cell address action
Use the Get cell address action to retrieve the location of the active cell and store it to a string variable.
This action supports .xlsx and .xlxm files.
Open a worksheet using the Open action. You must select the Contains header option when configuring
the Open action in order to use this action to retrieve the cell address based on the column title name.
1. Double-click or drag the Get cell address action from the Расширенный Excel node in the Actions

palette.
2. Select whether to retrieve the cell address from the Active cell or Based on header:

Вариант Шаги

Активная ячейка If you select this option, the бот will retrieve the
cell address of the currently active cell. Skip to
Step 5.
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Вариант Шаги

Based on header If you select this option, the бот will retrieve
the cell address of the cell specified by the
column title name and cell position. Complete the
following fields:
a. Enter the column title: If you selected the

Sheet contains header option when you
opened this sheet using the Open action,
enter the column name. For example, First
 Name.
If you did not select that option, enter the
default column name. For example, A.

Прим.:  Это поле заполняется без учета
регистра букв.

b. Enter cell position from column title:
Enter the number of cells between the
header cell and the cell from which you want
to retrieve the address. Enter up to three
digits.
For example, if the header cell is located at
B1 and you specify 2 as the cell position, the
action will return B3.

3. Select whether to retrieve the cell address from the Active cell or a Specific cell.
• If you have selected the Active cell option, the бот will retrieve the cell address of the currently

active cell. Skip to Step 5.
• If you have selected the Specific cell option, the бот will retrieve the cell address of the cell

specified by the column title name and cell position. Complete the following fields:
• Enter the column title: Enter the column name. For example, Name.

Прим.:  Это поле заполняется без учета регистра букв.

• Enter cell position from column title: Enter the number of cells between the header cell
and the cell from which you want to retrieve the address. Enter up to three digits.
For example, if the header cell is located at B1 and you specify 2 as the cell position, the action
will return B3.

4. In the Save active or user specified cell address in local variable field, create or insert an
existing string variable.
В  отображается описательное имя переменной по умолчанию. If you create several output
variables, subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

5. Enter the name of the session used to open the workbook with the Open .
6. Щелкните Сохранить.

Next, you can insert the string variable containing the cell address into the Specific cell field of actions
related to cell operations. См. раздел Cell operations in Расширенный Excel.
Using Get cell color action
Use the Get cell color action to get the color of the background or text in a cell.
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This action retrieves the color of a cell as RGB values. For example, if the background or text in a cell is of
red color, the value retrieved is 255,0,0.
1. Double-click or drag the Get cell color action from the Excel node in the Actions palette.
2. Select the Background color option to get the background color of the cell or the Text color option

to get the color of the text.
3. Select the Active cell option to get the color from the current active cell or the Specific cell option

to get the color from the address of the cell you have specified.
4. Select a variable from the Assign the output to variable list to assign the address of the empty cell

to the variable you have selected from the list.
5. Select the string variable you want to use to store the address of the empty cell from the Assign the

output to variable list.
В  отображается описательное имя переменной по умолчанию. If you create several output
variables, subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

6. Enter the name of the session used to open the workbook with the Open .
7. Щелкните Сохранить.

Get multiple cells action
The Get multiple cells action in the Расширенный Excel package enables you to retrieve the values from
the cells in a Microsoft Excel spreadsheet and stores them in a table variable.

Настройки

This  retrieves cell values as string data types. It supports Excel cell formats, including Number,
Percentage, Currency, Scientific, and Date. For example, a value from a cell of Currency formatting retains
the currency symbol when passed to a table or record variable.

Прим.:  You must convert the values to perform non-string operations.

• Выберите Несколько ячеек, чтобы извлечь значения из диапазона ячеек, или выберите
параметр Все ячейки, чтобы извлечь значения из всех ячеек.

Прим.:  When you run a бот with the Excel Advanced > Cell range option, ensure that you use a
numeric value as the last character in the From cell and To cell fields (for example, testa1). The last
character cannot be an alpha character.

• Выберите параметр Прочитать для чтения видимого текста или значения ячейки.
Например, если ячейка содержит значение 70%, параметр Прочитать значение ячейки
прочитает значение как 70, игнорируя формат %, в то время как Прочитать видимый текст
прочитает содержимое как 70%.

Прим.:  When you use the Read visible text option to process large data sets in Microsoft Excel
spreadsheets, the action consumes more time to process the data.

Recommendation:  Use the Read cell value option as the reading value for a better performance
than reading visible text.

• Enter the name of the session used to open the workbook with the Open .
• Select a table variable to store the retrieved values in the Assign value to variable list. В 

отображается описательное имя переменной по умолчанию. If you create several output variables,
subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.
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Using Get number of rows action
Use the Get number of rows action to get the number of rows that contain data.
To get the number of rows that are not empty or contain data, do the following:
1. Double-click or drag the Get number of rows action from the Excel node in the Actions palette.
2. Select the Index option to specify the number of the worksheet or the Name option to specify the

name of the worksheet from which you want to get the number or rows.
3. Select one of the following options:

• Non-empty rows: returns the total number of non-empty rows only.
• Total rows with data: returns the total number of rows including empty cells.

For example, consider the following illustration of an excel file:

The Non-empty rows returns the value 4, while Total rows with data returns the value 6.

4. Enter the name of the session used to open the workbook with the Open .
5. Select the number variable you want to use to store the output from the Assign to variable list.
6. Щелкните Сохранить.

Get single cell action
The Get single cell action in the Расширенный Excel package enables you to retrieve the values from a
single cell in a Microsoft Excel spreadsheet or a CSV file and store them in a string variable.

Настройки

This  retrieves cell values as string data types. It supports Excel cell formats, including Number,
Percentage, Currency, Scientific, and Date. For example, a value from a cell of Currency formatting retains
the currency symbol when passed to a table or record variable.

Прим.:  You must convert the values to perform non-string operations.

• Select the Active cell option to retrieve the value from the active cell, or select Specific cell to
retrieve the value from a specific cell in a Microsoft Excel spreadsheet.

• Выберите параметр Прочитать для чтения видимого текста или значения ячейки.
Например, если ячейка содержит значение 70%, параметр Прочитать значение ячейки
прочитает значение как 70, игнорируя формат %, в то время как Прочитать видимый текст
прочитает содержимое как 70%.

Recommendation:  Use the Read cell value option as the reading value from a cell for a better
performance than reading visible text.

• Enter the name of the session used to open the workbook with the Open .
• Select a string variable to store the retrieved values in the Store cell contents to list. В 

отображается описательное имя переменной по умолчанию. If you create several output variables,
subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.
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Прим.:  If the character limit in a single cell of a Microsoft Excel spreadsheet exceeds 8200, then the бот
reads only the first 8200 characters. This behaviour is specific only to Microsoft Excel spreadsheet.

Example of using a conditional statement

.
Go to cell action
The Go to cell action in the Расширенный Excel package enables you to move the cursor to a specific cell
in a Microsoft Excel spreadsheet or a CSV file.

Настройки

• Select the Specific cell option to specify the cell to which the cursor should be moved, or select an
option from the Active cell list.

Прим.:  You can enter a cell range in the Specific cell field to select the entire range of cells. For
example, to select all the cells in the second row and from the first through third column, enter A2:C2.

• Enter the name of the session used to open the workbook with the Open .

Go to next empty cell action
The Go to next empty cell action in the Расширенный Excel package enables you to find the next empty
cell in the current worksheet. You can specify whether to find the empty cell toward the left, right, up, or
down.

Настройки

• Select the Active cell or Specified cell option to specify the cell from which to start searching for the
empty cell. If you have selected the Specified cell option, specify the address of the cell in the field.

• Select the left, right, up, or down option to specify the direction in which to search for the next
empty cell.

• Enter the name of the session used to open the workbook with the Open .

Read cell formula action
The Read cell formula action in the Расширенный Excel package enables you to retrieve the formula
available in the Active cell or Specified cell and assign the output to a string variable. This action
returns a blank value if the specified cell does not contain a formula.

Настройки

• Enter the name of the session used to open the workbook with the Open .
• Select the Active cell or Specified cell option to specify the cell from which to read the formula. If

you have selected the Specified cell option, specify the address of the cell in the field.
• Select a string variable to store the name of the formula from the Assign the output to variable

list. В  отображается описательное имя переменной по умолчанию. If you create several output
variables, subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

Using the Replace action
Use the Replace action to find cells that contain a specific string and replace it with another string. This
action supports .xlsx, .xlsm, and .csv files.
1. Double-click or drag the Replace action from the Расширенный Excel node in the Actions palette.
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2. Select an option from the From list to specify a starting point of the cell range for search:
• Beginning: Starts the search from the beginning of the spreadsheet.
• End: Starts the search from the end of the spreadsheet.
• Active cell: Starts the search from the active cell in the spreadsheet.
• Specific cell: Enables you to specify the address of the cell from where you want to start the

search.

3. Select an option from the Till list to specify an end point of the cell range for search:
• Beginning: Ends the search at the beginning of the spreadsheet.
• End: Ends the search at the end of the spreadsheet.
• Active cell: Ends the search at the active cell in the spreadsheet.
• Specific cell: Enables you to specify the address of the cell where you want to end the search.

4. Specify the string you want to search for in the Find field.
5. Select from the following search options:

• By rows: Enables you to search by rows.
• By columns: Enables you to search by columns.
• С учетом регистра. Only performs this action on cells that contain a string that matches the

uppercase and lowercase characters of the string you specified in the Find field.
• Match entire cell contents: Enables you to find only those cells that contain the entire string

you have specified in the Find field.

6. Select Replace with and specify the replacement string, or leave the field blank to replace the
matching cells with an empty character.

7. Enter the name of the session used to open the workbook with the Open .
8. Щелкните Сохранить.

Set cell action
The Set cell action in the Расширенный Excel package enables you to set a value in the Active cell or
Specific cell in a Microsoft Excel spreadsheet or a CSV file. You can also use this action to set a formula.

Настройки

• Select the Active cell or Specified cell option to specify the cell in which to set the value. If you have
selected the Specified cell option, specify the address of the cell in the field. You can use the Set cell
action to set or change the value of any Active cell or Specified cell cell value (including the header
row).

Прим.:  You can enter a cell range in the Specific cell field to set a particular value in all the cells
of the range. For example, to set a value of 5 on all cells in the second row and from the first through
third column, enter A2:C2.

• Enter the value to set in the Cell value field.
• Enter the name of the session used to open the workbook with the Open .

Set cell formula action
The Set cell formula action in the Расширенный Excel пакет enables you to set a formula in the active cell
or a specific cell in a Microsoft Excel spreadsheet or a CSV file.
To generate a random number, use the Number > Random action. See Random action.
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Настройки

• Select the Set formula for active cell or Set formula for specified cell option to specify the cell in
which to set the formula. If you have selected the Set formula for specified cell option, specify the
address of the cell in the field.

• Enter the formula to set in the Enter formula for specific cell field.
• Enter the name of the session used to open the workbook with the Open .

Table operations in Расширенный Excel
The Excel advanced package contains various actions that you can use to automate tasks related to
table operations in a Microsoft Excel spreadsheet.

Table actions in the Excel advanced package

Прим.:  Ensure that a table is available in the workbook. A worksheet that contains data in various rows
and columns is not considered as a table.

Пакет Расширенный Excel включает следующие действия:

Действие Описание

Удалить столбец
таблицы

См. Delete table column action

Фильтрация таблицы См. раздел Using Filter table action.

Получить диапазон
таблицы

См. Get table range action

Вставить столбец в
таблицу

См. Insert table column action

Сортировать таблицу См. Sort table action

Delete table column action
The Delete table column action in the Расширенный Excel пакет enables you to delete a column in a
table.

Настройки

• Specify the Table name from which you want to delete a column.

Прим.:  The table name is a string value. It is NOT a data table name. For information on how to
retrieve the Excel table name, see Rename an Excel table.

• Select the Name or Position to specify the name or position of the column to delete.
• Enter the name of the session used to open the workbook with the Open .

Using Filter table action
Use the Filter table action to filter data from a column in a table.
To filter data in a table, do the following:
1. Double-click or drag the Filter table action from the Excel node in the Actions palette.
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2. Specify the name of the table from which you want to filter data in the Table name field.

Прим.:  The table name is a string value. It is NOT a data table name. For information on how to
retrieve the Excel table name, see .

3. Select the Column name to specify the name of the column or the Column position to specify the
position of the column that contains the data you want to filter.

4. Select the Number option if the column you have specified contains number data.
a) Select an option from the list to specify the operator you want to use to filter the data.

The following options are available:
• Equals: Filters the data that is equal to the value you have specified.
• Does not equal: Filters the data that is not equal to the value you have specified.
• Greater than: Filters the data that is greater than the value you have specified.
• Greater than or equal to: Filters the data that is greater than or equal to the value you

have specified.
• Less than: Filters the data that is less than the value you have specified.
• Less than or equal to: Filters the data that is less than or equal to the value you have

specified.
• Between: Filters the data that is between the two values you have specified.

Прим.:  Apart from the Between option, you do not have to provide a value in the second field.
If you have provided a value in the second field, the system ignores that value when filtering the
data.

5. Select the Text option if the column you have specified contains textual data.
a) Select an option from the list to specify the operator you want to use to filter the data.

The following options are available:
• Equals: Filters the data that is equal to the value you have specified.
• Does not equal: Filters the data that is not equal to the value you have specified.
• Begins with: Filters the data that begins with the value you have specified.
• Ends with: Filters the data that ends with the value you have specified.
• Contains: Filters the data that contains the value you have specified.
• Does not contain: Filters the data that does not contain the value you have specified.

6. Enter the name of the session used to open the workbook with the Open .
7. Щелкните Сохранить.

Get table range action
The Get table range action in the Расширенный Excel пакет enables you to get the range of a table
available in a worksheet and store the output in a string variable.

Настройки

• Specify the Table name for which you want to get the range.

Прим.:  The table name is a string value. It is NOT a data table name. For information on how to
retrieve the Excel table name, see .

© 2023 Automation Anywhere. All rights reserved.     1573



    Automation Anywhere - Сборка

• Select the options to specify whether you want to include a header and pivot table in the range and a
variable to store the output. В  отображается описательное имя переменной по умолчанию. If you
create several output variables, subsequent variable names are appended with a -1, -2, -3, and so on
to avoid duplication.

• Enter the name of the session used to open the workbook with the Open .

Insert table column action
The Insert table column action in the Расширенный Excel пакет enables you to insert a column in a table.

Настройки

• Specify the Table name in which you want to insert a column.

Прим.:  The table name is a string value. It is NOT a data table name. For information on how to
retrieve the Excel table name, see .

• Specify the name of the column in the Column name field and the position where you want to insert
the column in the Column position field.

• Enter the name of the session used to open the workbook with the Open .

Sort table action
The Sort table action in the Расширенный Excel пакет enables you to sort the data in a column of a table.
This action enables you to sort numeric and text data.

Настройки

Sorts the data in a column of a table. This action enables you to sort numeric and text data.
• Specify the Table name for which you want to sort the data.

Прим.:  The table name is a string value. It is NOT a data table name. For information on how to
retrieve the Excel table name, see .

• Select the Column name or Column position to specify the name or position of the column.
• Select an appropriate option from the Number or Text list to specify the sort order.
• Enter the name of the session used to open the workbook with the Open .

Важное замечание:  Ensure that Microsoft Excel is set to the same language as that of the computer
operating system.

CSV operations in Расширенный Excel
You can use some of the actions available in the Excel advanced package to perform various operations
on a CSV file.

CSV actions in the Excel advanced package

The following table lists the actions that you can use with a CSV file:

Supported Not Supported

Открыть Найти следующую пустую ячейку
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Задать ячейку Get cell colour

Перейти к ячейке Перейти к следующей пустой ячейке

Insert/Delete row column Выполнить макрос

Insert/Delete row column Показать все листы

Получить ячейку Hide row/column in selection

Найти/заменить Unhide row/column in selection

Convert excel to pdf Получить доступ к листу, защищённому
паролем

Удалить ячейки Protect/Unprotect workbook

Задать формулу ячейки Table related commands

Создать книгу Создать лист

You can use the Loop action to retrieve data from each row in a CSV file. You can also use any of the
above action that supports the use of a CSV file within a Loop action.

Прим.:  All the other actions available in the Excel advanced package that are not listed in the above
table cannot be used with a CSV file.

Файл пакет
Автоматизируйте различные операции, связанные с файлами, такие как создание, открытие,
копирование, переименование и удаление файлов, с помощью actions, доступных в пакет Файл.
actions из пакет Файл можно использовать по отдельности, чтобы выполнить action один раз, или в
action Цикл, чтобы выполнить action для каждого файла в папке.

Действия в Файл пакет

Прим.:  action Zip, доступное в пакет Папка, можно использовать для сжатия файлов. См. раздел
Zip action.

пакет Файл включает в себя указанные ниже actions.

Действие Описание

Присвоить См. Assign action

Копировать файл
рабочего стола

См. раздел Using Copy Desktop file action for file.

Создать См. Создать action

Копировать файл
Control Room

См. Copy Control Room file action

Создать ярлык .
См. Create shortcut action
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Действие Описание

Создать
символическую
ссылку

См. Create symbolic link action

Удалить См. раздел Using Delete action for file.

Получить имя См. Get name action

Получить путь См. Get path action

Открыть См. Open action

Печать См. раздел Using Print action for file.

Печать нескольких
файлов

См. раздел Using Print multiple files action.

Переименовать См. раздел Using Rename action for file.

Ссылки, связанные с данной
Если пакет
Use the actions in the Если пакет to control the sequence of execution based on one or more conditions
of a task.
Цикл пакет
Use the Цикл package to run a sequence of actions repeatedly for a specific number of times or until a
specific condition is met.
Variables overview
Automation 360 offers a variety of variables, each designed to hold specific types of data and is intended
for specific use. Use the topics below to learn more about each variable and how to use them.

Assign action
The Assign action in the File пакет enables you to assign a file from the Control Room , Desktop, or an
existing File variable to a user-defined File variable.

Настройки

Assigns a file from the Control Room , Desktop, or an existing File variable to a user-defined File variable.

Using Copy Desktop file action for file
Use the Copy Desktop file action to copy an existing file from Desktop to another location. This action
enables you to copy a file based on its size and the date it was created or modified.
To copy an existing file, follow these steps:
1. In the Действия palette, from the Файл пакет, double-click or drag the Copy Desktop file action.
2. From the Source file field select one of the following options:

• Specific: Specify the name and location of the file.
• For Regex: Specify the source folder path.

You can use a regular expression (regex) in your source file or folder path to support a pattern-
based search. Выберите регулярное выражение в виде строки или шаблона для каждого
условия регулярного выражения и введите значение.
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For example, if want to copy, delete, rename or print multiple files from your source folder using
pattern based search, use regular expressions either as a String and enter the value as My_ for all
file name starting with My_ or as a Pattern such as [a-z]{3}(.txt|xlxs) to retrieve files that
matches this pattern.

3. In the Destination file/folder field, specify the name of the file and location.
4. Select the Overwrite existing files check box to overwrite an existing file with the same name at

the specified location.
• If the Overwrite existing files option is not selected, the system appends the name

of the copied file with a numeric value. For example, if you have copied a file named
June_Quarter_report.pdf and a file with the same name exists in the location
where you want to save the copied file, the system saves the copied file as Copy of
 June_Quarter_report.pdf for the first time. When you copy the same file in the same folder
for the second time, it saves the copied file as Copy (2) of June_Quarter_report.pdf. The
numeric value is incremented each time you copy a file with the same name when the overwrite
check box is not selected.

• If you want to copy a file that is already available in the destination folder where the source and
the destination folders are different and the Overwrite existing files check box is not selected,
then the system shows the following error message: Unable to copy file(s) <path
\filename> as the specified file(s) exists.

5. Select the Size check box to copy a file based on its size.
a) Select any of the following options from the list:

• Atleast: Copies a file only if the file size is more than the size you have specified.
• Atmost: Copies a file only if the file size is less than the size you have specified.
• Exact: Copies a file only if the file size is the same as the size you have specified.

b) Specify a value in the Size field.
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6. Select the Date check box to copy a file based on the date it was created or modified.
a) Select one of the options from the list:

• Created: Enables you to copy a file based on the date it was created.
• Modified: Enables you to copy a file based on the date it was modified.

b) Select the Is within last option and specify a value in the field.
This option enables you to perform the operation on the file if it was created or modified within
the number of days you have specified. For example, if you specify 7 in the field, the system
performs the operation on the file if it was created or modified in the last 7 days.

c) Select the Is between option to specify a period.
This option enables you to specify a Start date and an End date for the period. For example, if
you specify 01/01/19 as the start date and 01/31/19 as the end date of the period, the system
performs the operation on the file if it was created or modified between this period.

Прим.:  The Start date and End date are included in the period.

d) Select the Is before option and specify a value in the field.
This option enables you to perform the operation on the file if it was created or modified on or
before the date you have specified.

e) Select the On a date option and specify a date in the field.
This option enables you to perform the operation on a file if it was created or modified on the
date that you specified.

7. Щелкните Сохранить.

Создать action
The Create action in the File пакет enables you to create a new file.

Настройки

• В поле Файл укажите имя, включая место хранения файла.
• В разделе Заменить существующий файл выберите существующий файл с тем же именем,

чтобы перезаписать его. Если существующие файлы не перезаписываются, то Control Room
добавляет к имени нового файла числовое значение.

Using Delete action for file
Use the Delete action to delete a file. This action enables you to delete a file based on its size and the
date it was created or modified.
Follow these steps to delete a file:
1. In the Действия palette, double-click or drag the Delete action from the Файл пакет.
2. From the Source file field select one of the following options:

• Specific: Specify the name and location of the file.
• For Regex: Specify the source folder path.

You can use a regular expression (regex) in your source file or folder path to support a pattern-
based search. Выберите регулярное выражение в виде строки или шаблона для каждого
условия регулярного выражения и введите значение.
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For example, if want to copy, delete, rename or print multiple files from your source folder using
pattern based search, use regular expressions either as a String and enter the value as My_ for all
file name starting with My_ or as a Pattern such as [a-z]{3}(.txt|xlxs) to retrieve files that
matches this pattern.

3. Select the Size check box to delete a file based on its size.
a) Select any of the following options from the list:

• Atleast: Deletes a file only if the file size is more than the size you have specified.
• Atmost: Deletes a file only if the file size is less than the size you have specified.
• Exact: Deletes a file only if the file size is the same as the size you have specified.

b) Specify a value in the Size field.

4. Select the Date check box to delete a file based on the date it was created or modified.
a) Select one of the options from the list:

• Created: Enables you to delete a file based on the date it was created.
• Modified: Enables you to delete a file based on the date it was modified.

b) Select the Is within last option and specify a value in the field.
This option enables you to perform the operation on the file if it was created or modified within
the number of days you have specified. For example, if you specify 7 in the field, the system
performs the operation on the file if it was created or modified in the last 7 days.

c) Select the Is between option to specify a period.
This option enables you to specify a Start date and an End date for the period. For example, if
you specify 01/01/19 as the start date and 01/31/19 as the end date of the period, the system
performs the operation on the file if it was created or modified between this period.

Прим.:  The Start date and End date are included in the period.

d) Select the Is before option and specify a value in the field.
This option enables you to perform the operation on the file if it was created or modified on or
before the date you have specified.

e) Select the On a date option and specify a date in the field.
This option enables you to perform the operation on a file if it was created or modified on the
date that you specified.

5. Щелкните Сохранить.

Copy Control Room file action
The Copy Control Room file action in the File пакет enables you to copy a Control Room file to a specific
location.

Настройки

• В Файл Control Room укажите файл для копирования. Для копирования файла из репозитория
Control Room выберите один из указанных ниже вариантов.
• Статический путь к файлу. Позволяет просмотреть репозиторий Control Room и выбрать

файл. Используйте этот вариант, если путь к файлу является статическим.
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Прим.:  При просмотре репозитория Control Room с помощью варианта Статический путь к
файлу файлы с расширением .bot не отображаются.

• Динамический путь к файлу. Позволяет просмотреть репозиторий Control Room и выбрать
файл. Кроме того, этот вариант также позволяет вставлять переменные в путь к файлу,
чтобы копировать файлы из репозитория Control Room, в котором путь к файлу является
динамическим. Можно вставить переменную, содержащую весь путь к файлу или часть пути к
файлу.
Например, C:\user\My Docs\test.csv или C:\user\My Docs\$fileName$

• В поле Путь к целевому файлу укажите путь к месту, где требуется сохранить файл. Можно
вставить переменную, содержащую весь путь к файлу или часть пути к файлу.
Например, C:\user\My Docs\test.csv или C:\user\My Docs\$fileName$

Прим.:  Если отсутствует структура папок, бот создает все необходимые папки.

• Выберите True или False или вставьте логическую переменную, чтобы указать, нужно ли
перезаписывать существующий файл.

Get name action
The Get name action in the File пакет enables you to get the name of the file.

Настройки

Извлекает имя файла из Control Room, рабочего стола или существующей файловой переменной и
сохраняет имя файла в выбранной выходной строковой переменной.

Get path action
The Get path action in the File пакет enables you to get the path of the file.

Настройки

Извлекает путь к файлу из Control Room, рабочего стола или существующей файловой переменной и
сохраняет путь к файлу в выбранной выходной строковой переменной.

Прим.:  Если для получения пути к файлу выбрать вариант Control Room, бот отображает путь к
локальному, загруженному файлу Control Room.

Open action
The Open action in the File пакет enables you to open an existing file.

Настройки
В поле Файл укажите имя, включая место хранения файла.
Используя регулярное выражение (regex) или поиск по шаблону, можно открыть существующий
файл, соответствующий критериям поиска. Выберите регулярное выражение в виде строки или
шаблона для каждого условия регулярного выражения и введите значение.
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Using Print action for file
Use the Print action to print a file. This action enables you to print a file based on its size and the date it
was created or modified.
Follow these steps to print a file:
1. In the Действия palette, double-click or drag the Print action from the Файл пакет.
2. In the File field, specify the name and location of the file.
3. Select the Size check box to print a file based on its size.

a) Select one of the options from the list:
• Atleast: Prints a file only if the file size is more than the size you have specified.
• Atmost: Prints a file only if the file size is less than the size you have specified.
• Exact: Prints a file only if the file size is the same as the size you have specified.

b) Specify a value in the Size field.

4. Select the Date check box to print a file based on the date it was created or modified.
a) Select any of the following options from the list:

• Created: Enables you to print a file based on the date it was created.
• Modified: Enables you to print a file based on the date it was modified.

b) Select the Is within last option and specify a value in the field.
This option enables you to perform the operation on the file if it was created or modified within
the number of days you have specified. For example, if you specify 7 in the field, the system
performs the operation on the file if it was created or modified in the last 7 days.

c) Select the Is between option to specify a period.
This option enables you to specify a Start date and an End date for the period. For example, if
you specify 01/01/19 as the start date and 01/31/19 as the end date of the period, the system
performs the operation on the file if it was created or modified between this period.

Прим.:  The Start date and End date are included in the period.

d) Select the Is before option and specify a value in the field.
This option enables you to perform the operation on the file if it was created or modified on or
before the date you have specified.

e) Select the On a date option and specify a date in the field.
This option enables you to perform the operation on a file if it was created or modified on the
date that you specified.

5. Щелкните Сохранить.

Using Print multiple files action
Use Print multiple files to print multiple files based on the size and the date they were created or
modified.
Follow these steps to print multiple files:
1. In the Действия palette, double-click or drag the Print multiple files action from the Файл пакет.
2. In the Folder field, specify the name and location of the folder.
3. From the File type field, select String to specify the file type of your files or Regex
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Use the regular expression in your source file or folder path to support pattern based search. Select
the regular expression (Regex) either as a String or Pattern for each regex condition and input the
regex value.
For example, you can use regular expressions either as a String and enter the value as My_ for all
file name starting with My_ or as a Pattern such as [a-z]{3}(.txt|xlxs) to retrieve files that
matches this pattern.

4. Select the Include subfolders check box to include all the subfolders in your selected folder.
5. Select the Size check box to print multiple files based on their size.

a) Select any of the following options from the list:
• Atleast: Prints multiple files only if the file size is more than the size you have specified.
• Atmost: Prints multiple files only if the file size is less than the size you have specified.
• Exact: Prints multiple files only if the file size is the same as the size you have specified.

b) Specify a value in the Size field.

6. Select the Date check box to print multiple files based on the date they were created or modified.
a) Select one of the options from the list:

• Created: Enables you to print multiple files based on the date they were created.
• Modified: Enables you to print multiple files based on the date they were modified.

b) Select the Is within last option and specify a value in the field.
This option enables you to perform the operation on the files if they were created or modified
within the number of days you have specified. For example, if you specify 7 in the field, the
system performs the operation on the files if they were created or modified in the last 7 days.

c) Select the Is between option to specify a period.
This option enables you to specify a Start date and an End date for the period. For example, if
you specify 01/01/19 as the start date and 01/31/19 as the end date of the period, the system
performs the operation on the files if they were created or modified between this period.

Прим.:  The Start date and End date are included in the period.

d) Select the Is before option and specify a value in the field.
This option enables you to perform the operation on the files if they were created or modified on
or before the date you have specified.

e) Select the On a date option and specify a date in the field.
This option enables you to perform the operation on a file if it was created or modified on the
date that you specified.

7. Щелкните Сохранить.

Using Rename action for file
Use the Rename action to rename a file. This action enables you to rename a file based on its size and
the date it was created or modified.
To rename a file, follow these steps:
1. In the Действия palette, double-click or drag the Rename action from the Файл пакет.
2. From the Source file field select one of the following options:

• Specific: Specify the name and location of the file.
• For Regex: Specify the source folder path.
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You can use a regular expression (regex) in your source file or folder path to support a pattern-
based search. Выберите регулярное выражение в виде строки или шаблона для каждого
условия регулярного выражения и введите значение.
For example, if want to copy, delete, rename or print multiple files from your source folder using
pattern based search, use regular expressions either as a String and enter the value as My_ for all
file name starting with My_ or as a Pattern such as [a-z]{3}(.txt|xlxs) to retrieve files that
matches this pattern.

3. In the New file name field, specify a new name for the file.
4. Select the Size check box to rename a file based on its size.

a) Select one of the options from the list:
• Atleast: Renames a file only if the file size is more than the size you have specified.
• Atmost: Renames a file only if the file size is less than the size you have specified.
• Exact: Renames a file only if the file size is the same as the size you have specified.

b) Specify a value in the Size field.

5. Select the Date check box to rename a file based on the date it was created or modified.
a) Select any of the following options from the list:

• Created: Enables you to rename a file based on the date it was created.
• Modified: Enables you to rename a file based on the date it was modified.

b) Select the Is within last option and specify a value in the field.
This option enables you to perform the operation on the file if it was created or modified within
the number of days you have specified. For example, if you specify 7 in the field, the system
performs the operation on the file if it was created or modified in the last 7 days.

c) Select the Is between option to specify a period.
This option enables you to specify a Start date and an End date for the period. For example, if
you specify 01/01/19 as the start date and 01/31/19 as the end date of the period, the system
performs the operation on the file if it was created or modified between this period.

Прим.:  The Start date and End date are included in the period.

d) Select the Is before option and specify a value in the field.
This option enables you to perform the operation on the file if it was created or modified on or
before the date you have specified.

e) Select the On a date option and specify a date in the field.
This option enables you to perform the operation on a file if it was created or modified on the
date that you specified.

6. Щелкните Сохранить.

Create shortcut action
The Create shortcut action in the File пакет enables you to create a shortcut to a target file.
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Настройки

Creates a shortcut to a file at a user-specified location. Ярлык зависит от исходного файла, поэтому
любые изменения исходного файла также применяются к ярлыку.
• В поле Местоположение цели укажите имя и местоположение.
• В поле Местоположение ярлыка укажите имя и местоположение.

Прим.:  Пользователи с действующей ролью и необходимыми разрешениями могут создавать
ярлыки файлов в указанном месте.

Create symbolic link action
The Create a symbolic link action in the File пакет enables you to create a symbolic link to a target file.

Настройки

Creates a symbolic link to a file at a user-specified location. Ярлык зависит от исходного файла, поэтому
любые изменения исходного файла также применяются к ярлыку.
• В поле Местоположение цели укажите имя и местоположение.
• In the Symbolic link location field, specify the name and location.

Прим.:  Создавать ярлыки файлов в указанном месте могут только пользователи с
административным доступом.

Папка пакет
Automate folder-related operations by using the actions available in the Папка пакет.

Действия в Папка пакет

пакет Папка включает в себя указанные ниже actions.

Действие Описание

Zip См. раздел Zip action.

Копировать См. раздел Copy action in Папка.

Создать See .Create action in Папка.

Извлечь См. раздел Unzip action.

Удалить См. раздел Delete action in Папка.

Создать ярлык См. раздел Create shortcut action.

Открыть См. раздел Open action in Папка.

Переименовать См. раздел Rename action in Папка.
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Действие Описание

Создать
символическую
ссылку

См. раздел Create symbolic link action.

Zip action
The Zip action enables you to compress files and folders into a .zip format.
1. In the Действия  palette, double-click or drag the Zip action from the Folder пакет.
2. In the Specify file(s)/folder(s) to compress field, specify the location.
3. In the Specify file type(s) to compress field, select one of the following options:

• Строка. Specify the file extension.
For example, you can specify .txt and .png to compress only text files and PNG images. The system
compresses the entire folder if you do not specify any file type. You can also specify the name of a
file to compress a specific file.

• Regex: Select the regular expression (regex) either as a String or Pattern for each reguar
expression condition and enter the value.
For example, you can use regular expressions either as a String and enter the value as My_ for all
file name starting with My_ or as a Pattern such as [a-z]{3}(.txt|xlxs) to retrieve files that
matches this pattern.

4. In the Specify destination filename and location field, specify the zip file name and location.
5. Select the Update only if newer check box to compress the files only if one or more files were

updated after the last compression.
This option is useful when you are repeatedly compressing the same set of files and storing the output
zip file with the same name at the same location. For example, you compress five PDF files from the
Reports folder on a monthly basis and save the output zip file with the Monthly Report name in
the D: drive. When this option is selected, the system compresses the files only if one or more PDF
files are updated after the last compression.

6. Select the Delete original files check box if you want to delete the original files after they are
included in the zip file.

7. In the Compression list, select between Normal, Fast, and Superfast to specify the speed for
compression.

8. Необязательно: In the Password protection field, click one of the following tabs to set a password:
• Учетные данные. To specify a stored password.
• Переменная. To set a variable for password.
• Строка. To enter a password manually.

9. Щелкните Сохранить.

Copy action in Папка
The Copy action enables you to copy an existing folder into a specific location.
1. In the Действия palette, double-click or drag the Copy action from the Folder пакет.
2. In the Source folder field, specify the name and location.
3. In the Destination folder field, specify the folder name and location to save the copied folder.
4. Select the Overwrite existing files/folders check box to overwrite existing folders with the same

name.

© 2023 Automation Anywhere. All rights reserved.     1585



    Automation Anywhere - Сборка

If this option is not enabled, the system appends a numeric value at the end of the file name. For
example, if you save the June_Quarter_report file in a location that has a file with the same
name, the system saves the file as June_Quarter_report_(1).pdf. The numeric value is
incremented each time you save the file as long as the option is enabled.

5. Необязательно: Select the Size check box to copy a folder based on its size.
a) Use the drop-down menu to select one of the following options:

• Atleast: Copies a folder only if the folder size is more than the size you have specified.
• Atmost: Copies a folder only if the folder size is less than the size you have specified.
• Exact: Copies a folder only if the folder size is the same as the size you have specified.

b) In the Size (KB) field, specify the folder size.

6. Необязательно: Select the Date check box to copy a folder based on the date.
a) Use the drop-down menu to select one of the following options:

• Created: To copy a folder based on the date it was created.
• Modified: To copy a folder based on the date it was modified.

b) Use the second drop-down menu to select one of the following additional options:
• Relative to runtime: To set the date in regards to the бот runtime.
• Between two dates: To specify the time period.

This option enables you to specify a Start date and an End date of the period. For example,
if you specify 01/01/19 and 01/31/19 as the start date and end date, the system performs
the operation on the folder if it was created or modified between these dates.

Прим.:  The Start date and End date are included in the period.

• On a date: To specify a particular date.
This option enables you to set a specific date that a folders was created or modified.

• Before a date: To specify a date prior to which the folders were created.
For example, if you set the date as 07/28/20, folders created or modified before this date are
selected
(Optional) Select the Including date check box if you want include the date you have
specified for the Before a date option.

7. Щелкните Сохранить.

Create action in Папка
The Create action enables you to create a folder.

Настройки

• In the Folder field, specify the name and location.
Folder names cannot include system actions or device references such as AUX, CON, LPT, NUL, and
PRN.
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• (Optional) Select the Overwrite an existing folder check box to overwrite an existing folder.

Прим.:  If this option is not selected, the system appends the name of the new folder with a numeric
value.

Unzip action
The Unzip action enables you to extract compressed content (files and folders) into a specific location
from a .zip file.
1. In the Действия  palette, double-click or drag the Unzip action from the Folder пакет.
2. In the Zip file name with full path field, specify the name and location.
3. In the Extract to path field, specify the location.
4. Select the Replace existing file check box to overwrite the file.
5. Необязательно: In the Password to access zip file field, click one of the following tabs to set a

password:
• Учетные данные. To specify a stored password.
• Переменная. To set a variable for password.
• Строка. To enter a password manually.

6. Щелкните Сохранить.

Delete action in Папка
The Delete action enables you to remove or delete folder from specific location.
1. In the Действия palette, double-click or drag the Delete action from the Folder пакет.
2. In the Folder field, specify the name and location.
3. Необязательно: Select the Size check box to delete a folder based on its size.

a) Use the drop-down menu to select of the following options:
• Atleast: Deletes a folder only if the folder size is more than the size you have specified.
• Atmost: Deletes a folder only if the folder size is less than the size you have specified.
• Exact: Deletes a folder only if the folder size is the same as the size you have specified.

b) In the Size field, specify the folder size.

4. Необязательно: Select the Date check box to delete a folder based on the date it was created or
modified.
a) Use the drop-down menu to select one of the following options:

• Created: To delete a folder based on the date it was created.
• Modified: To delete a folder based on the date it was modified.

b) Use the second drop-down menu to select one of the following additional options:
• Relative to runtime: To set the date in regards to the бот runtime.
• Between two dates: To specify the time period.

This option enables you to specify a Start date and an End date of the period. For example,
if you specify 01/01/19 and 01/31/19 as the start date and end date, the system performs
the operation on the folder if it was created or modified between these dates.

Прим.:  The Start date and End date are included in the period.
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• On a date: To specify a particular date.
This option enables you to set a specific date that a folders was created or modified.

• Before a date: To specify a date prior to which the folders were created.
For example, if you set the date as 07/28/20, folders created or modified before this date are
selected
(Optional) Select the Including date check box if you want include the date you have
specified for the Before a date option.

5. Щелкните Сохранить.

Create shortcut action
The Create shortcut action enables you to create a shortcut of a folder at a specified location. As the
folder shortcut is dependent on the source folder, any changes to the source folder is applied to the
shortcut as well.

Настройки

• Use the Target location field to select one of the following tabs:
• Папка рабочего стола. Click Browse to select the folder that you want to create a shortcut for.
• Переменная. Enter or paste the filepath of the folder that you want to create a shortcut for.

• Use the Shortcut location field to select one of the following tabs:
• Папка рабочего стола. Click Browse to select the folder where the folder shortcut must be

created.
• Переменная. Enter the filepath where the folder shortcut must be created.

Прим.:  Only the users with administrator role can create a shortcut of the source folder at a specified
location.

Open action in Папка
The Open action enables you to open a folder from a specific location.

Настройки

• Use the Folder field to specify the filepath of the folder you want to open.
• (Optional) Click the Insert a value icon to select a variable.

Rename action in Папка
The Rename action enables you to rename an existing folder.
1. In the Действия palette, double-click or drag the Rename action from the Folder пакет.
2. In the Folder field, specify the name and location.
3. In the New folder name field, specify a new name.
4. Select the Size check box to rename a folder based on its size.
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a) Select any of the following options from the list:
• Atleast: Renames a folder only if the folder size is more than the size you have specified.
• Atmost: Renames a folder only if the folder size is less than the size you have specified.
• Exact: Renames a folder only if the folder size is the same as the size you have specified.

b) In the Size field, specify the folder size.

5. Select the Date check box to rename a folder based on the date it was created or modified.
a) Select any of the following options from the list:

• Created: To rename a folder based on the date it was created.
• Modified: To rename a folder based on the date it was modified.

b) Use the second drop-down menu to select one of the following additional options:
• Relative to runtime: To set the date in regards to the бот runtime.
• Between two dates: To specify the time period.

This option enables you to specify a Start date and an End date of the period. For example,
if you specify 01/01/19 and 01/31/19 as the start date and end date, the system performs
the operation on the folder if it was created or modified between these dates.

Прим.:  The Start date and End date are included in the period.

• On a date: To specify a particular date.
This option enables you to set a specific date that a folders was created or modified.

• Before a date: To specify a date prior to which the folders were created.
For example, if you set the date as 07/28/20, folders created or modified before this date are
selected
(Optional) Select the Including date check box if you want include the date you have
specified for the Before a date option.

6. Щелкните Сохранить.

Create symbolic link action
The Create symbolic link action enables you to create a symbolic link to a folder at a specified location.
As this link is dependent on the source folder, any changes you make to the source folder is applied to the
symbolic link.

Настройки

• Use the Target location field to select one of the following tabs:
• Папка рабочего стола. Click Browse to select the folder that you want to create a shortcut for.
• Переменная. Enter or paste the filepath of the folder that you want to create a shortcut for.

• Use the Symbolic link location field to select one of the following tabs:
• Папка рабочего стола. Click Browse to select the folder where the folder shortcut must be

created.
• Переменная. Enter the filepath where the folder shortcut must be created.
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Прим.:  Only the users with administrator role can create a shortcut of the source folder at a specified
location.

FTP / SFTP пакет
Use the FTP / SFTP пакет to automate FTP / SFTP operations.
An FTP/SFTP server hosts the files to share. The client accesses, downloads, or uploads files to the server.
The transfer of data between the client and server is done using a TCP/IP network, which is the standard
protocol of communication over the internet.
• The following are some forms of authentication for an FTP server:

• User credentials: Requires an FTP username and password.
• Anonymous: This form of authentication is enabled on sites where files are available for public

access and the users need not identify themselves to the server.
• Key-based: SFTP authentication is usually done with a private and public key. The key pair is

automatically generated by the computer. The private key is kept with the SFTP client and the
corresponding public key with the SFTP server. When establishing a connection, the client shares the
private key to be matched with the corresponding public key on the server.

• FTP can run in active or passive transfer mode.
• In the active mode, the client informs the server about the port used for listening and starts listening

for incoming data connections from the server.
• In the passive mode, the client receives a server IP address and server port number from the

server. The client opens a data connection to the server IP address and server port number that are
received. Most organizations prefer the passive mode because it involves less or no alterations to the
firewall settings.

• FTP supports binary and ASCII file transfer types:
• Use the binary option when transferring executable files.
• Use the ASCII option when transferring text files.

Перед началом работы

Perform the following actions within the FTP / SFTP пакет.
1. Establish a connection with the FTP/SFTP server using the Connect action. When establishing a

connection, associate the FTP/SFTP server details with a session name. Use the same session name
for all corresponding actions.

2. Use the FTP/SFTP actions to automate a task. The actions enable you to perform following tasks:
• Upload, download, delete, or rename files.
• Upload, download, create, or delete folders.
• Navigate to the parent folder or a specific folder.

3. After you have automated the tasks related to FTP / SFTP, terminate the connection to the server
using the Disconnect action.

Прим.:  SFTP with SSH1 protocol is no longer supported by SFTP.
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Действия в FTP / SFTP пакет

пакет FTP / SFTP включает в себя описанные ниже actions.

Прим.:  Regarding the use of a semicolon (;) in folder or file names, the following guidelines apply:
• You can use a semicolon (;) in the folder name for the following actions: Delete or Create folder
• You must not use a semicolon (;) in the folder or file name for other actions, such as the following:

Change folder, Delete files, Get files, Get folder, Put files, Put folders, and Rename files

Действие Описание

Изменить папку См. раздел Change folder action.

Подключить См. раздел Connect action.

Создать папку См. раздел Create folder action.

Удалить папку См. раздел Delete folder action.

Удалить файлы См. раздел Delete files action.

Отключить См. раздел Disconnect action.

Получить папки См. раздел Get folders action.

Получить файлы См. раздел Get files action.

Разместить папки См. раздел Put folders action.

Разместить файлы См. раздел Put files action.

Переименовать
файлы

См. раздел Rename files action.

Change folder action
The Change folder action enables you to navigate to either a parent folder or a specific folder on an FTP/
SFTP server.

Настройки

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Navigate to field to select one of the following options:
• Go to parent folder
• Specific folder

Ensure that you enter the complete folder path when you select the Specific folder option.

Connect action
The Connect action enables you to establish a connection with an FTP/SFTP server that you want to use
for automating tasks. Это должно быть первое действие, используемое для автоматизации задачи,
связанной с FTP/SFTP.
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Укажите сведения о сервере FTP/SFTP и свяжите его с именем сеанса. Используйте имя сеанса,
указанное в этом action в других actions, чтобы не пришлось указывать данные о сервере в этих
actions.
1. Double-click or drag the Connect action in the FTP/SFTP node in the Actions palette.
2. In the FTP/SFTP Session name field to enter a name for the session.
3. In the Server name field, enter the FTP/SFTP server name.
4. In the Port field, enter the FTP/SFTP server port number.
5. Use the Server type filed to select one of the following server type:

Тип сервера Шаги

FTP Тип проверки подлинности. Можно выбрать аутентификацию
пользователя, либо используя Имя пользователя и пароль, либо
войдя в систему как Анонимный пользователь. Если вы выбрали Имя
пользователя и пароль, заполните указанные ниже поля.
• В разделе Имя пользователя и пароль выберите Компонент

учетных данных, переменная или Небезопасная строка.
• Введите значения в поля Имя пользователя и Пароль.

Если решено выполнять аутентификацию с использованием учетных
данных пользователя (имени пользователя и пароля), вставьте
Credential Vault для повышения уровня безопасности или введите
значение непосредственно в поле Небезопасная строка.

Режим передачи. Выберите режим передачи данных Активный или
Пассивный.
Тип передачи. Выберите тип Двоичный или ASCII для передачи
файлов между сервером и клиентом.
Необязательно. Введите путь к каталогу по умолчанию на
FTP-сервере.

FTP Secure Тип проверки подлинности. Можно выбрать аутентификацию
пользователя, либо используя Имя пользователя и пароль, либо
войдя в систему как Анонимный пользователь. Если вы выбрали Имя
пользователя и пароль, заполните указанные ниже поля.
• В разделе Имя пользователя и пароль выберите Компонент

учетных данных, переменная или Небезопасная строка.
• Введите значения в поля Имя пользователя и Пароль.

Если решено выполнять аутентификацию с использованием учетных
данных пользователя (имени пользователя и пароля), вставьте
Credential Vault для повышения уровня безопасности или введите
значение непосредственно в поле Небезопасная строка.

© 2023 Automation Anywhere. All rights reserved.     1592



    Automation Anywhere - Сборка

Тип сервера Шаги

Secure FTP Выберите Ключ и имя пользователя, Ключ и учетные данные
или Учетные данные для аутентификации пользователя.
• Ключ и имя пользователя. Выберите Файл закрытого

ключа из Файла Control Room, Файла рабочего стола или
Переменной. To enter the Username, select from the following
options:Credential, variable, , and Insecure string.

• Ключ и учетные данные. Выберите Файл закрытого ключа из
Файла Control Room, Файла рабочего стола или Переменной.
To enter the Username, select from the following options:Credential,
variable, , and Insecure string.

• Прим.:  Убедитесь, что на SFTP-сервере имеется соответствующий
файл открытого ключа.

• Учетные данные: Выберите Компонент учетных данных,
Переменная или Небезопасная строка для ввода значения в
поля Имя пользователя и Пароль.
Если решено выполнять аутентификацию с использованием учетных
данных пользователя (имени пользователя и пароля), вставьте
Credential Vault для повышения уровня безопасности или введите
значение непосредственно в поле Небезопасная строка.

6. Необязательно: Select Reconnect if connection fails check box.
Use the following drop-down menus to select additional options while reconnecting:
a) Attempts: Select the number of times the action must attempt to reconnect.
b) Time between attempts: Select the time lapse between each attempt.

Прим.:  Если происходит сбой подключения из-за неправильных учетных данных, при
выполнении action попытки восстановления соединения не предпринимаются.

7. Щелкните Сохранить.

Create folder action
The Create folder action enables you to create a folder on an FTP/SFTP server.

Настройки

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Remote folder field to specify the filepath where the folder must be created on the FTP/SFTP
server.

Прим.:  The system encounters an error if a folder with the same name exists in the parent folder.
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Delete folder action
The Delete folder action enables you to remove or delete a folder (including all the subfolders and files
within it) from an FTP/SFTP server.

Настройки

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Remote folder field to specify the filepath of the folder that must be deleted from the FTP/
SFTP server.

Delete files action
The Delete files action enables you to remove or delete files from an FTP/SFTP server.

Настройки

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Remote files field to specify the filepath of the file(s) that must be deleted from the FTP/SFTP
server.

Disconnect action
The Disconnect action enables you to close or terminate an active connection to the FTP/SFTP server.

Настройки

In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

Get folders action
The Get folders action enables you to download a folder on an FTP/SFTP server into a client machine.

Настройки

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Remote folder field to enter the filepath of the folders on the remote FTP/SFTP server that
you want to download.
Specify filters using wildcard characters to download only specific types of files.
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• Use the Local folder field to enter the location on your local device where you want to download the
folders from the FTP/SFTP server.

• (Optional) Click the Select date drop-down menu to specify folders based on the date they were
modified or created.

Get files action
The Get files action enables you to download files from a remote FTP/SFTP folder to a specific location on
a client machine.

Настройки

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Remote files field to enter the filepath of the files on the remote FTP/SFTP server that you
want to download.
Specify filters using wildcard characters to download only specific types of files.

• Use the Local folder field to enter the location of the client machine where you want to download the
files from the FTP/SFTP server.

• Use the Transfer Type to select one of the following formats of the download files:
• Binary
• ASCII

• (Optional) Use the Select date drop-down menu to specify files based on the date they are modified
or created.

Put folders action
The Put folders action enables you to upload a folder from a client machine to the FTP/SFTP server.

Настройки

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Local folder field to enter the location of the client machine from where you want to upload
folder to FTP/SFTP server.
Specify filters using wild card characters to restrict uploads to specific types of files.

• (Optional) Use the File types field to specify the type of files that must be included in the upload
folder.

Put files action
The Put files action enables you to upload one or more files from a client machine to an FTP/SFTP server.

Настройки

• In the Session name field, enter the session name for FTP/SFTP server.
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Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Local files field to enter the location of the client machine from where you want to upload files
to FTP/SFTP server.
Specify filters using wild card characters to restrict uploads to specific types of files.

• Use the Transfer type field to select one of the following upload format of the files:
• Binary
• ASCII

Rename files action
The Rename files action enables you to edit or change the name of files on an FTP/SFTP server.

Настройки

• In the Session name field, enter the session name for FTP/SFTP server.
Use the same session name that you have provided when establishing a connection with the FTP/SFTP
server using the Connect action.

• Use the Remote file field to specify the filepath of the file that you want to rename.
• Use the New remote file field to enter the new name of the file.

Fuzzy match пакет
Use the Fuzzy match action to compare the values of two strings or files for similarity. This action returns
a decimal value; the closer the value to 1.0, the greater the similarity between the two strings.

Важное замечание:  This is a beta пакет and is currently not available with the Automation 360
Enterprise and Cloud editions.

Use this action to automate the process of evaluating strings of data for similiarity. For example, you have
an automation sequence in which a бот extracts data from invoices, searches a database for the company
record, and updates the record with data from the invoice. Use the Fuzzy match action to handle two
possible scenarios:
• A mistake occurs at the extraction step where a letter is incorrectly extracted. Instead of Apple, the bot

extracts App1e, with a numerical one instead of the letter l.
• There is a small variation between the company name on the invoice and in the database. The invoice

contains the company name Apple Inc, but the database has a record for the company name Apple.

Genesys пакет
Automate the repetitive tasks related to onboarding and updating the details of contacts by using the
actions in the Genesys пакет.

Intended use

The actions in the Genesys пакет are intended for use with the Automation Anywhere for Genesys
integration. Currently, data cannot be passed directly from the integration to Genesys. These actions
require a source data file to call from. You can then choose to manipulate the data by using variables or
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another worksheet before passing the final changes back to the Genesys source file. The actions included
in this пакет are intended to offer automated solutions for common tasks.

Actions in the Genesys пакет

Use the following actions in the Genesys пакет to automate common onboarding and updating tasks.

Действие Описание

Аутентификация The OAuth authenticate action calls your Genesys credential
token and is required for the бот to connect with the API.
• Введите URL-адрес для Облачной среды Genesys.
• Select how you would like your credentials passed.

• Use Credential to pick a preconfigured credential locker.
• Use Variable to select a preconfigured credential variable.
• Use Insecure string to enter your credential in the field

without encryption.

• Введите учетные данные, необходимые для доступа к среде
для Идентификатора клиента.

• Select how you would like your secret passed.
• Use Credential to pick a preconfigured credential locker.
• Use Variable to select an established variable.
• Use Insecure string to enter your secret in the field

without encryption.

• Введите секретный код клиента OAuth, используемый при
предоставлении учетных данных Секрет клиента.

• Введите Имя сеанса для ваших изменений в репозитории.

Деление Perform actions related to division details, such as adding and
removing roles to a division. Division palette

External contact Perform actions such as adding and updating contact details.
External contact palette

Группа Perform actions such as adding and deleting members from a
group. Group palette

Язык Perform actions such as adding, listing, and removing routing
languages. Language palette

External organization Perform actions such as creating, updating, and deleting
organizations. External organization palette

Телефон Perform actions such as assigning, creating, and removing phone
records. Phone palette

Очереди Perform actions such as adding and removing selections from
queues. Queues palette

Функция Perform actions such as adding, setting, and removing roles for
users. Role palette

Skill Perform actions such as adding, replacing, and removing skills. Skill
palette
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Действие Описание

Пользователь Perform actions such as creating, deleting, and getting users. User
palette

Division palette
The Genesys command пакет offers a palette of actions to detail and access the role of divisions.

Division palette for Genesys

A division is a way to group and segregate objects while keeping them inside the same organization.
For example, you can organize divisions by business unit, country, and office location and then assign
respective objects that are configured for each individual division. After you organize and configure
divisions, you can use roles to grant user access to division configurations and thus the objects within the
respective division.
The Genesys пакет includes the following division actions:

Действие Описание

Add role into division Detail a role for a division.
• Enter the ID of the user account for Internal user ID.
• Enter the ID of the division for Division ID.
• Enter the role of the division for Role ID.
• Введите Имя сеанса для ваших изменений в репозитории.

Bulk-add roles into division Detail multiple roles in a division.
• Select how data is organized within your Division dataset.

• If using a Table:
• Click Edit table to create your table.
• Enter the data into the cells of your table.

• If using Variable, then select the established variable of the
data to be added to the division.

• Select the proper ID of the first, second, and third columns.
These must correspond with the User, Role, and Division IDs of
your dataset.

• Введите Имя сеанса для ваших изменений в репозитории.
• Optionally, Choose a variable where the data will be saved.
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Действие Описание

Bulk-remove roles for division Delete multiple roles from a division.
• Select how data is organized within your Division dataset.

• If using a Table:
• Click Edit table to create your table.
• Enter the data into the cells of your table.

• If using Variable, then select the established variable of the
data to be removed from the division.

• Select the proper ID of the first, second, and third columns.
These must correspond with the User, Role, and Division IDs of
your dataset.

• Введите Имя сеанса для ваших изменений в репозитории.
• Optionally, Choose a variable where the data will be saved.

Bulk-replace roles in division Replace multiple roles in a division.
• Select how data is organized within your Division dataset.

• If using a Table:
• Click Edit table to create your table.
• Enter the data into the cells of your table.

• If using Variable, then select the established variable of the
data to replace in the division.

• Select the proper ID of the first, second, and third columns to
map the corresponding User, Role, and Division IDs of your
dataset.

• Введите Имя сеанса для ваших изменений в репозитории.
• Optionally, Choose a variable where the data will be saved.

Get the home division Retrieve the home division for the organization.
• Введите Имя сеанса для ваших изменений в репозитории.
• Select how the outcome data will be saved.

• If using Multiple variables, use the following steps for
each variable:
• Click Add variable mapping.
• Enter the Key of the variable.
• Choose a variable where the data will be saved.
• Click Add for this division to be saved to the configured

variable.

• If using a Dictionary variable, then select the established
variable.
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Действие Описание

List/search divisions Retrieve the home division for the organization.
• Optionally, enter the Division name.
• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the data will be saved.

Remove role from division Delete a grant of a role in a division.
• Enter the ID of the user account for Internal user ID.
• Enter the ID of the division for Division ID.
• Enter the role of the division for Role ID.
• Введите Имя сеанса для ваших изменений в репозитории.

External contact palette
The Genesys пакет offers a palette of actions to detail and access data for external contact records.

External Contact palette for Genesys

An external contact includes a comprehensive repository of data relevant to making contact with an
individual or external organization. From an external contact record, you have a streamlined view of all
contact and organization data.
Detail as much or as little relevant data beyond the first and last name of the contact. Optional data can
include salutation, title, external organization ID, multiple phones, addresses, and an external system URL.

Прим.:  When providing the organization ID that represents an external organization in Genesys, the
contact will be linked to that org.

The Genesys пакет includes the following external contact actions:

Действие Описание

Create contact Add details of a new contact.
• Enter the first name.
• Enter the last name.
• Enter optional data.
• Select Yes or No for the Survey opt out.
• Введите Имя сеанса для ваших изменений в репозитории.
• Optionally, Choose a variable where the external contact ID

will be saved.

Delete contact Delete an external contact.
• Enter the External contact ID.
• Введите Имя сеанса для ваших изменений в репозитории.
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Действие Описание

List/search contacts Find and view specific contacts that match your search query.
• Optionally, enter the External contact ID.
• Optionally, enter keywords for your Search query.
• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the outcome data will be saved.

Update contact Update the details for an external contact.
• Enter the External contact ID of the record that you want to

update.
• Enter the first name
• Enter the last name
• Enter optional data.
• Select Yes or No for Survey opt out.
• Введите Имя сеанса для ваших изменений в репозитории.

Group palette
The Genesys пакет offers a palette of actions to detail and access data for grouping records.

Group palette for Genesys

Groups organize people with similar traits. For example, users that share skills, locations, or other
information maintained in Genesys Cloud can be grouped for organizational functions.
Groups can be work-related or social to assist in project and priorities. Examples of groups include the
following:
• Subject Matter Experts (SMEs): A group of SMEs can let others in the organization know the most

current information.
• Projects: Groups related to projects streamline information to the team and expedite updates and

planning.
• Locations: Groups can simplify communication for geographical updates and events.

The Genesys пакет includes the following group actions:

Действие Описание

Bulk-add members into group Add multiple members into a group.
• Enter the Group ID.
• Select how the data will be entered to begin adding user data.

• If using a List:
• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be entered in the group.

• Введите Имя сеанса для ваших изменений в репозитории.
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Действие Описание

Delete member Delete a member from a group.
• Enter the Group ID.
• Select how the data will be entered to begin deleting user data

from the group.
• If using a List:

• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be deleted from the group.

• Введите Имя сеанса для ваших изменений в репозитории.

List groups View all groups.
• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the outcome data will be saved.

List members List all the members in a specific group.
• Enter the Group ID.
• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the outcome data will be saved.

Language palette
The Genesys пакет offers a palette of actions to detail languages for call-routing purposes.

Language palette for Genesys

Languages are separate from Automatic Call Distribution (ACD) skills. For example, Genesys Cloud will
prioritize an agent that speaks the language requested by the customer over an agent who is more skilled
but cannot speak the requested language. An agent that cannot speak the language of the customer does
not receive that interaction regardless of ACD skill.
Attributing users with languages empowers your team to handle diverse calls with effective
communication. The Genesys пакет includes the following language actions:

Действие Описание

Add routing language Add a routing language to a user.
• Enter a unique user ID for the Internal user ID.
• Enter the Language ID that is to be added to the user.
• Enter the user's language Proficiency with a value of 0-5. Zero

is low proficiency.
• Введите Имя сеанса для ваших изменений в репозитории.
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Действие Описание

Bulk-add routing languages to
user

Attribute multiple users with languages.
• Select how the dataset will be entered.

• If using a Table:
• Click Edit table to create your table.
• Enter the data of the cells for your table.

• If using Variable, then select the established variable of the
data to be added to the user.

• Select the proper ID of the first, second, and third columns to
map the corresponding User, Role, and Division IDs of your
dataset.

• Введите Имя сеанса для ваших изменений в репозитории.
• Optionally, Choose a variable where the outcome data will be

saved.

List user's routing languages List the languages attributed to a user.
• Enter the unique user ID for the Internal user ID.
• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the outcome data will be saved.

List all routing languages List all the supported languages.
• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the outcome data will be saved.

Remove routing language
from user

Remove an attributed language from a user.
• Enter the unique user ID for the Internal user ID.
• Enter the Language ID to be removed.
• Введите Имя сеанса для ваших изменений в репозитории.

External organization palette
The Genesys пакет offers a palette of actions to detail and access data for external organization records.

External organization palette for Genesys

External organizations are your customers, partners, and other businesses that you interact with. An
organization (org) can also be considered an account and is related to External Contacts in that contacts
belong to an org. Simply put, contacts are customers and the relationship defines what business a contact
might be calling about. Allowing an agent to view customer information and the org of the customer help
the agent to quickly understand the relevant business details to best serve their needs. Therefore, having
the org details available to боты can enable workflows, such as automatically importing account data into
Genesys from other systems, using Genesys Org details to look up open cases for the account from an
external case management tool, and so on.
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Similar to contacts, you can detail as much or as little relevant data beyond the name of the org. Optional
data can include company type, industry, multiple phones, addresses, tags, and websites. The Genesys
пакет includes the following external organization actions:

Действие Описание

Create organization Create the initial external organization record.
• Enter the Name of the org.
• Enter the optional data.
• Select whether the org approved to be contacted through

Phone SMS.
• Select whether the org approved to be contacted through Fax

SMS.
• Введите Имя сеанса для ваших изменений в репозитории.
• Optionally, Choose a variable where the org ID can be saved.

Delete organization Delete a record of an external organization.
• Enter the ID for the external organization.
• Введите Имя сеанса для ваших изменений в репозитории.

Get organization Call the details of an external organization record.
• Enter the ID for the external organization.
• Введите Имя сеанса для ваших изменений в репозитории.
• Select how the outcome data will be saved.

• If using Multiple variables, use the following steps for
each variable:
• Click Add variable mapping.
• Enter the Key of the variable.
• Choose a variable where the data will be saved.
• Click Add for this data to be saved to the configured

variable.

• If using a Dictionary variable, then select the established
variable where the outcome data can be saved.

List/search organizations Call a list of external organizations that match your search query.
• Optionally, enter keywords for your Search query.
• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the outcome data will be saved.

Update organization Update an external organization record with new or additional data.
• Enter the ID of the external organization record.
• Enter the Name of the org.
• Enter the optional data.
• Select whether the org approved contact through Phone SMS.
• Select whether the org approved contact through Fax SMS.
• Введите Имя сеанса для ваших изменений в репозитории.
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Phone palette
The Genesys пакет offers a palette of actions to detail and access data for phone records.

Phone palette for Genesys

Genesys Cloud supports the WebRTC technology with the Genesys Cloud WebRTC phone. The Genesys
Cloud WebRTC phone runs from a browser, that is, there are no special hardware requirements or software
to download. When the Genesys Cloud WebRTC phone is enabled, you can immediately use it to make and
receive calls. It is an important part of the onboarding process that phones be created and assigned to
agents so that calls are effectively routed from the queue to agents.
Configuring a Genesys Cloud WebRTC phone is a two-step operation. First, base settings must be
created and configured by the admin and must already be established. Second, the phone is created and
configured to retrieve established base settings. These secondary tasks can be automated. The Genesys
пакет includes the following phone actions:

Действие Описание

Assign phone Assign a phone line to a user.
• Enter a unique user ID for the Internal user ID.
• Enter a line ID to assign the Phone's line ID to the user.
• Введите Имя сеанса для ваших изменений в репозитории.

Create a phone Create a phone record.
• Enter a Name for the phone.
• Enter the Phone base setting ID to route the preconfigured

base settings.
• Enter the Site ID where the phone is located.
• Enter the Web rtc user ID of the WebRTC user.
• Введите Имя сеанса для ваших изменений в репозитории.
• Optionally, Choose a variable for the Phone ID.
• Optionally, Choose a variable for the Phone's line ID.

List phone base settings Get a list of phone base settings.
• Optionally, enter a Name for the list.
• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the outcome data can be saved.

List/search phones Get a list of phones.
• Optionally, enter a Name for the list.
• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the outcome data can be saved.

List/search sites Get a list of sites.
• Optionally, enter a Name for the list.
• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the outcome data can be saved.
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Действие Описание

Remove a phone Remove a phone record.
• Enter the Phone ID to be removed.
• Введите Имя сеанса для ваших изменений в репозитории.

Queues palette
The Genesys command пакет offers a palette of actions to detail and access data for grouping records.

Queues palette for Genesys

Queues are the waiting lines of interactions. Agents select the On Queue status to enter their predefined
queues. Contact center queue settings include creating and managing queues for voice and chat channels
for the entire organization. The Genesys пакет includes the following queues actions:

Действие Описание

Add to queue Add selection to queue.
• Введите Имя сеанса для ваших изменений в репозитории.
• Enter the Queue ID of the queue that you want to add.
• Select how the data will be entered to begin adding user data to

the queue.
• If using a List:

• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be entered in the queue.

List members List the members of a queue.
• Введите Имя сеанса для ваших изменений в репозитории.
• Enter the Queue ID of the queue that you want to add.
• Choose a variable where the outcome data can be saved.

List/search queues Retrieve a list of queues that match your input criteria.
• Optionally, enter a Name for the list.
• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the outcome data can be saved.
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Действие Описание

Remove from queue Remove selected users from a queue.
• Введите Имя сеанса для ваших изменений в репозитории.
• Enter the Queue ID for the queue that you want to remove

users from.
• Select how the data will be entered to begin adding user data to

the queue.
• If using a List:

• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be entered in the queue.

Role palette
The Genesys пакет offers a palette of actions to detail and access data for the roles of users.

Role palette for Genesys

Because permissions are based on the assigned role, the role of users is important in the on-boarding
process. Tasks are then assigned based on the permissions that a user has. The Genesys пакет includes
the following role actions:

Действие Описание

Add users to role Add a list of users to a role.
• Enter the Role ID of the role that you want to add users to.
• Select how the data will be entered to begin adding user data to

the role.
• If using a List:

• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be added to the role.

• Введите Имя сеанса для ваших изменений в репозитории.

List/search roles Retrieve a list of roles for the organization.
• Optionally, enter the Role name for the list.
• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the outcome data can be saved.
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Действие Описание

List user's roles Retrieve a list of roles and permissions for a user.
• Enter the unique ID of the user for the Internal user ID.
• Введите Имя сеанса для ваших изменений в репозитории.
• Select how the outcome data will be saved.

• If using Multiple variables, use the following steps for
each variable:
• Click Add variable mapping.
• Enter the Key of the variable.
• Choose a variable where the data will be saved.
• Click Add for this list to be saved to the configured

variable.

• If using a Dictionary variable, then select the established
variable where the outcome data can be saved.

List users in a role Retrieve a list of the unique user IDs of the users in the specified
role.
• Enter the Role ID for the list.
• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the outcome data can be saved.

Remove users from role Remove a list of users from a specific role.
• Enter the Role ID that you want to remove users from.
• Select how the data will be entered to begin adding user data

that will be removed from the role.
• If using a List:

• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be removed from the role.

• Введите Имя сеанса для ваших изменений в репозитории.
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Действие Описание

Set the user's roles Set the roles for a specific user.
• Enter the unique ID of the user for the Internal user ID.
• Select how the data will be entered to begin adding role data

that will be attributed to the user.
• If using a List:

• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be attributed to the user.

• Введите Имя сеанса для ваших изменений в репозитории.

Skill palette
The Genesys пакет offers a palette of actions to detail and access the skills of agents.

Skill palette for Genesys

Genesys allows for defining Automatic Call Distribution (ACD) and profile-based skills for agents. An ACD
skill routes each contact to the available agents who can best meet the contact's needs. Profile skill data
becomes keywords for advanced searches and parameters for creating groups and can also be used by
the Workforce Management capabilities to create schedule scenarios. The Genesys пакет includes the
following skill actions:

Действие Описание

Add user routing skills Attribute routing skills to a user.
• Enter a unique user ID for the Internal user ID.
• Enter the Skill ID that is to be added to the user.
• Enter the user's skill Proficiency with a value of 0-5. Zero is

low proficiency.
• Введите Имя сеанса для ваших изменений в репозитории.
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Действие Описание

Bulk-add routing skills Add multiple routing skills to a single user.
• Select how the skill dataset will be entered.

• If using a Table:
• Click Edit table to create your table.
• Enter the data in the cells for your table.

• If using Variable, then select the established variable of the
data to be added to the user.

• Select the proper data of the first, second, and third columns
to map the corresponding User ID, Skill ID, and Skill
proficiency of your dataset.

• Введите Имя сеанса для ваших изменений в репозитории.
• Optionally, Choose a variable where the outcome data will be

saved.

Bulk-replace routing skills Replace multiple routing skills for a single user.
• Select how the skill dataset will be entered.

• If using a Table:
• Click Edit table to create your table.
• Enter the data in the cells for your table.

• If using Variable, then select the established variable of the
data to be replaced.

• Select the proper data of the first, second, and third columns
to map the corresponding User ID, Skill ID, and Skill
proficiency of your dataset.

• Введите Имя сеанса для ваших изменений в репозитории.
• Optionally, Choose a variable where the outcome data will be

saved.

List/search routing skills Retrieve a list of routing skills.
• Optionally, enter a Skill name for the list.
• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the outcome data will be saved.

List user's routing skills Retrieve a list of user's routing skills.
• Enter a unique user ID for the Internal user ID.
• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the outcome data will be saved.
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Действие Описание

Remove user routing skills Remove routing skills for a user.
• Enter a unique user ID for the Internal user ID.
• Enter the Skill ID that you want to remove.
• Введите Имя сеанса для ваших изменений в репозитории.

User palette
The Genesys пакет offers a palette of actions to detail and access user records.

User palette for Genesys

A person is on-boarded as a user. User records can then be assigned with different attributes and roles.
The user record begins the process of building out a fully organized work force. The Genesys пакет
includes the following user actions:

Действие Описание

Создать пользователя Create a new user.
• Enter the user's Email (login ID).
• Select how you would like your password entered.

• Use Credential to pick a preconfigured credential locker.
• Use Variable to select an established credential variable.
• Use Insecure string to enter your credential in the field.

• Enter the Password required for the user to sign in.
• Enter the Full name of the user.
• Enter a Division ID for the user.
• Select whether the user State is active or inactive in the

repository.
• Optionally, enter the user's Title and Department.
• Введите Имя сеанса для ваших изменений в репозитории.

Удалить пользователя Delete an existing user.
• Enter the unique user ID for the Internal user ID that you

want to delete.
• Введите Имя сеанса для ваших изменений в репозитории.
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Действие Описание

Get user Retrieve the details of a user.
• Enter a unique user ID for Internal user ID.
• Введите Имя сеанса для ваших изменений в репозитории.
• Select how the outcome data will be saved.

• If using Multiple variables, use the following steps for
each variable:
• Click Add variable mapping.
• Enter the Key of the variable.
• Choose a variable where the data will be saved.
• Click Add for this data to be saved to the configured

variable.

• If using a Dictionary variable, then select the established
variable where outcome data can be saved.

List/search users Retrieve a list of users that match your input criteria.
• Select how the data will be entered to begin adding user data to

the search.
• If using a List:

• Select the data Type.
• Enter the Value of the data in the list.

• If using Variable, then select the established variable of the
data to be added to the list.

• Optionally, select whether the State of the user is active or
inactive.

• Введите Имя сеанса для ваших изменений в репозитории.
• Choose a variable where the outcome data can be saved.

Update user Update the details of a user. Leave any field blank if no update is
needed.
• Enter a unique user ID for the Internal user ID.
• Enter the data that you want to update, such as the following:

• Email (login ID)
• Department
• Manager
• Date hired
• Employee type
• Biography, Interests, or Hobbies
• Spouse

• Select to turn Auto answer on or off for connecting calls to the
user.

• Введите Имя сеанса для ваших изменений в репозитории.
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Google Calendar package
The Google Calendar пакет contains actions that enable you to automate creating and deleting events.

Перед началом работы

Use the actions in the Google Calendar пакет in the following order:
1. Используйте параметр Подключить , чтобы установить подключение с сервером Google.

См. раздел Using the Connect action for Google packages.
2. Используйте комбинацию , доступных в этом , для автоматизации задач.

Прим.:  Используйте  из других  Google, установите подключение с помощью параметра
Подключить  из этого .

3. Используйте параметр Отключить , чтобы разорвать подключение.

Действия in the Google Calendar пакет

The Google Calendar пакет includes the following actions:

Действие Описание

Создать событие См. раздел Using the Create event action in Google
Calendar.

Подключить См. раздел Using the Connect action for Google
packages.

Отключить См. раздел Disconnect action for Google пакеты.

Удалить событие См. раздел Delete event action in Google Calendar.

Using the Create event action in Google Calendar
Use the Create event action to create an event and specify event attendees, duration, location,
recurrence, and title. During run time, this action triggers an email notification to meeting attendees.
To create a new calendar event, do the following:
1. Enter the session name you used to connect to the G-Suite server in the Connect action.

См. раздел Using the Connect action for Google packages.
2. Enter the event title.
3. Необязательно: Enter the location.
4. Необязательно: Enter the attendees' email addresses, separated with commas.
5. Enter the start date.

Use the format yyyy-MM-dd.
6. Enter the end date.

Use the format yyyy-MM-dd.
7. Select the All Day or Specify Time option from the Event Time option.

• If you select the All Day option, you do not need to provide any additional details.
• If you select the Specify Time option, complete the following fields:
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• Specify the Start Time using the HH:mm:ss format.
• Specify the End Time using the HH:mm:ss format.

8. Select the Use System Timezone or Specify Timezone option from the Timezone option.
• If you select the Use System Timezone option, you do not need to provide any additional

details.
• If you select the Specify Timezone option, complete the following fields:

• Specify the Start Timezone.
• Specify the End Timezone.

9. Необязательно: Mark the Recurring option to make this event repeat.
10. Select a Visibility option from the drop-down list.

Select from Default, Public, or Private.
11. Необязательно: Enter an event description.
12. Необязательно: Select a string variable from the drop-down list to store the id of the created event.
13. Щелкните Сохранить.

Using the Connect action for Google packages
Use the Connect action to establish a connection with the Google server in order to use other actions
from that same пакет to automate tasks. All of the fields in this action accept a credential from the
Credential Vault, variable, or a user-input value.
Configure the OAuth settings in the Google Cloud Platform and retrieve the credentials necessary to
connect Automation Anywhere Enterprise with your Google G Suite applications.
1. If you have not already done so, create a project.
2. Enable the APIs for the Google G Suite applications you want to automate, such as the Google Диск

API, Google Календарь API, and Google Таблицы API.
3. Do the steps in Setting up OAuth 2.0 to generate the Client ID and Secret.

Прим.:
• Select the Web application option.
• Add this authorized redirect URI: http://localhost:8888/Callback

4. Do these steps to set up user consent for the username that you will use to connect to the Automation
Anywhere Enterprise.

1. In the Действия palette, double-click or drag the Connect action from the пакет you want to use.
2. In the Username field, you can provide a valid username or select the credential or credential

variable that contains your Google username. To enter a value, click Insecure string.
3. If you are configuring the Connect action for the Google Календарь or Google Таблицы пакет, enter

a session name.
4. In the Client Id field, select the credential or credential variable that contains the client ID. To enter a

value, click Insecure string.
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5. In the Redirect URI field, enter http://localhost:8888/Callback

Прим.:  For the Google Таблицы пакет, the Redirect URI attribute is not supported. Enter the fixed
redirect URL directly in Google Cloud Platform: http://localhost:8888/Callback

6. In the Client secret field, select the credential or credential variable that contains the access token.
To enter a value, click Insecure string.

7. For Google Таблицы, you can specify the wait time (in minutes) in the Wait for action to complete
(In minutes) field when performing actions such as Get, Set, or Delete. By default, the wait time is
10 minutes.
If the Google sheet does not open within the time you specify, the task proceeds to execute the next
set of actions.

Прим.:  When you use Connect action to connect to the Google server, the option Wait for action
to complete (In minutes) is only supported in Google Таблицы пакет.

8. Щелкните Сохранить.
9. After you add actions from a specific Google package, use the Disconnect action from that same

Google package to terminate the connection.

The first time the бот runs, the Google login window is displayed. You must select the Google account and
approve the requested access permissions.
The token file gets generated for the first time after you provide the access permissions when the бот gets
deployed. It is created based on values that you provide in the Username, Client Id and Client secret
field, and asks for credentials only the first time to provide the access permission. Next time it uses the
same token file to connect to the Google Таблицы.
The token file is located at C:\Users\&lt;username&gt;\AppData\Local\AutomationAnywhere
\G-SuitAuth, where C:\Users\&lt;username&gt; is the user home directory of the respective
system.
If you enter the correct credentials when providing access permissions for the first time and can connect to
the Google Таблицы successfully, then next time if there is a change in only the password, you need not
delete the token file as it will work as expected.
Use other the actions from the same Google пакет to automate tasks. To use actions from another Google
пакеты, establish a connection using the Connect action from that пакет.
Ссылки, связанные с данной
Google Calendar package
The Google Calendar пакет contains actions that enable you to automate creating and deleting events.
Пакет Google Диск
Автоматизируйте задачи, связанные с файлами и папками, используя actions в пакет Google Диск.
Google Sheets пакет
пакет Google Таблицы содержит actions, которые позволяют автоматизировать задачи, связанные
с ячейками, столбцами, строками и листами.

Disconnect action for Google пакеты
Use the Disconnect action from a specific Google package to terminate the connection after you have
added actions from the same Google package.
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Настройки

• In the Username field, you can provide a valid username or select the credential or credential variable
that contains your Google username. To enter a value, click Insecure string.

• For Google Calendar and Google Sheets пакеты, enter the session name that you used in the Connect
action.

• Select the check box Logout from the browser if you want to sign off from your account.

Delete event action in Google Calendar
You can remove an event from the calendar using the Delete event action.

Настройки

Removes the event from the calendar.
• Enter the same session name that you provided in the Connect .
• Enter the Event Id. This is the string in the URL that appears after /eventedit/ when you open an

event for editing.
• Необязательно. Assign the event to a String variable.

Пакет Google Диск
Автоматизируйте задачи, связанные с файлами и папками, используя actions в пакет Google Диск.

Перед началом работы

Используйте actions из пакет Google Диск в указанном ниже порядке.
1. Используйте параметр Подключить , чтобы установить подключение с сервером Google.

См. раздел Using the Connect action for Google packages.
2. Используйте комбинацию , доступных в этом , для автоматизации задач.

Прим.:  Используйте  из других  Google, установите подключение с помощью параметра
Подключить  из этого .

3. Используйте параметр Отключить , чтобы разорвать подключение.
См. раздел Disconnect action for Google пакеты.

Действия из пакет Google Диск

пакет Google Диск включает в себя указанные ниже actions.

Действие Описание

Проверить разрешения См. раздел Check permissions action in Google
Диск.

Копировать файл См. раздел Copy file action in Google Диск.
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Действие Описание

Копировать папку См. раздел Copy folder action in Google Диск.

Создать разрешение на файл См. раздел Create file permission action in Google
Диск.

Создать папку См. раздел Create folder action in Google Диск.

Удалить файл См. раздел Delete file action in Google Диск.

Удалить разрешение на доступ к файлу См. раздел Delete file permission action in Google
Диск.

Удалить папку См. раздел Delete folder action in Google Диск.

Загрузить файл См. раздел Download file action in Google Диск.

Найти файл/папку См. раздел Find file/folder action in Google Диск.

Получить информацию о файле См. раздел Get file information action in Google
Диск.

Получить разрешение на доступ к файлу См. раздел Get file permission action in Google
Диск.

Переместить файл См. раздел Move file action in Google Диск.

Переместить папку См. раздел Move folder action in Google Диск.

Открыть файл Открывает файл из указанного каталога в
Google Диске.
• Введите то же имя пользователя, которое

вы указали в поле Подключить .
• Выберите способ идентификации

файла: по пути к файлу и имени или
идентификатору.

Прим.:  Идентификатор — это значение в
URL-адресе после последней прямой косой
черты. For example, if the URL is https://
docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.
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Действие Описание

Открыть папку Открывает папку из указанного каталога в
Google Диске.
• Введите то же имя пользователя, которое

вы указали в поле Подключить .
• Select whether to identify the folder by

directory path and name, or by ID.

Прим.:  Идентификатор — это значение в
URL-адресе после последней прямой косой
черты. For example, if the URL is https://
docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

Переименовать файл См. раздел Rename file action in Google Диск.

Переименовать папку См. раздел Rename folder action in Google Диск.

Отправить файл См. раздел Upload file action in Google Диск.

Обновить разрешение на файл Обновляет разрешение для файла
• Выберите способ идентификации

файла: по пути к файлу и имени или
идентификатору.

Прим.:  Идентификатор — это значение в
URL-адресе после последней прямой косой
черты. For example, if the URL is https://
docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is
12dlAwvrEA4JeLysfFky9.

• В поле Идентификатор разрешения
введите свой идентификатор
пользователя.

• Выберите роль. Подробнее см. на
веб-странице Роли Google Диска.

• Необязательно. Выберите или создайте
переменную для сохранения разрешений.

Check permissions action in Google Диск
The Check permissions action enables you to check permissions for a file or folder on Google Диск and
returns read, write, or delete to a list variable.

Настройки

Checks for a file or folder permissions and returns read, write, or delete to a list variable.
• Введите то же имя пользователя, которое вы указали в поле Подключить .

© 2023 Automation Anywhere. All rights reserved.     1618

https://developers.google.com/drive/api/v3/ref-roles


    Automation Anywhere - Сборка

• Выберите, следует ли проверять разрешения для файла или папки. Выберите Файл или Папка
и введите имя и путь к файлу или папке. To check the permissions of files shared with you in Google
Drive, select File ID to enter the file id. You can extract the file id from the URL of the file name and
enter it in the File ID field.

Прим.:  Если выбрать Идентификатор файла, Пользователь с правом на
комментирование и доступом на запись заметит, что бот не проверяет разрешение на запись и
возвращает значение false.

• Чтобы проверить различные виды разрешений, выберите Чтение, Записать или Удалить.
В результате логической переменной возвращается значение read (читать), write (запись) или
delete (удалить).

• Выберите или создайте логическую переменную для хранения разрешений.

Copy file action in Google Диск
The Copy file action enables you to copy a file from one folder to another on Google Drive.

Настройки

• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Select whether to identify the source file by file path and name, or by ID.

Прим.:  Идентификатор — это значение в URL-адресе после последней прямой косой
черты. For example, if the URL is https://docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is 12dlAwvrEA4JeLysfFky9.

• Выберите способ идентификации папки назначения: по пути и имени или идентификатору.
• Необязательно. Установите флажок Переименовать файл и введите новое имя файла.

Copy folder action in Google Диск
Use Copy folder action to copy a folder from one location to another.

Настройки

Копирует папку из одного места в другое.
• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Выберите способ идентификации исходной папки: по пути к папке и имени или идентификатору.

If this is a shared folder, you must use the Folder ID option.

Прим.:  Идентификатор — это значение в URL-адресе после последней прямой косой
черты. For example, if the URL is https://docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is 12dlAwvrEA4JeLysfFky9.

• Выберите способ идентификации папки назначения: по пути и имени или идентификатору.

Create file permission action in Google Диск
You can create a new permission for a file by using the Create file permission action.
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Настройки

Создает новое разрешение для файла
• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Select whether to identify the file by file path and name, or by ID.

Прим.:  Идентификатор — это значение в URL-адресе после последней прямой косой
черты. For example, if the URL is https://docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is 12dlAwvrEA4JeLysfFky9.

• Выберите роль. Подробнее см. на веб-странице Роли Google Диска.
• Выберите тип получателя Выберите из указанных ниже вариантов.

• Пользователь
• Группа
• Домен
• Любой человек

• Если выбран вариант «Пользователь» или «Группа», введите адрес электронной почты. Если
выбран домен, укажите домен.

• Необязательно. Выберите или создайте переменную для сохранения разрешений.

Create folder action in Google Диск
This action enables you to create a folder in Google drive.

Настройки

Создает папку.
• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Укажите родительскую папку, в которой будет создана папка. To create the folder in the root folder

enter root.
• Введите имя папки.
• Необязательно. Выберите или создайте строковую переменную для сохранения

идентификатора новой папки.

Прим.:  You cannot create a folder in the Shared with me folder because Google API does not support it.

Delete file action in Google Диск
Use the Delete file action to delete a file on your Google Drive.

Настройки

• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Select whether to identify the file by file path and name, or by ID.

Прим.:  Идентификатор — это значение в URL-адресе после последней прямой косой
черты. For example, if the URL is https://docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is 12dlAwvrEA4JeLysfFky9.
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• Необязательно. Выберите или создайте логическую переменную для сохранения статуса
удаления файла.

Delete file permission action in Google Диск
You can delete a file permission for a file by using the Delete file permission action.

Настройки

• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Select whether to identify the file by file path and name, or by ID.

Прим.:  Идентификатор — это значение в URL-адресе после последней прямой косой
черты. For example, if the URL is https://docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is 12dlAwvrEA4JeLysfFky9.

• В поле Идентификатор разрешения введите идентификатор разрешения.
• Необязательно. Выберите или создайте переменную для сохранения разрешений.

Delete folder action in Google Диск
Delete folder action enables you to delete a folder from the Google Drive.

Настройки

• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Выберите способ идентификации папки: по пути и имени или идентификатору.

Прим.:  Идентификатор — это значение в URL-адресе после последней прямой
косой черты. For example, if the URL is https://drive.google.com/drive/
folders/0B0MqCb--3Y8QQzlJcVRJb3UxcTg, the ID is 0B0MqCb--3Y8QQzlJcVRJb3UxcTg.

• Необязательно. Выберите или создайте логическую переменную для сохранения статуса
удаления папки.

Download file action in Google Диск
You can download a file from your Google Drive to a specific location on your desktop.

Настройки

• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Select whether to identify the file by file path and name, or by ID.

Прим.:  Идентификатор — это значение в URL-адресе после последней прямой косой
черты. For example, if the URL is https://docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is 12dlAwvrEA4JeLysfFky9.

• Укажите путь к файлу загрузки. Например, C:/Users/Downloads.
• Необязательно. Чтобы перезаписать одноименный файл, установите флажок Заменить

существующий файл.
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• Необязательно. Чтобы ввести новое имя для загруженного файла, установите флажок
Переименовать файл.

• Необязательно. Выберите или создайте переменную для сохранения идентификатора
загруженного файла.

Find file/folder action in Google Диск
The Find file/folder action enables you to find files or folders in a specific directory in your Google Drive.

Настройки

• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Выберите объект поиска: файлы или папки.
• Укажите исходную папку для поиска. Например, /Home/Accounts/.
• Укажите, следует ли возвращать точные совпадения или
• введите имя файла или папки для поиска.
• Выберите или создайте переменную для сохранения списка файлов и папок.

Get file information action in Google Диск
Use the Get file information action in the Google Диск пакет to enable you to get the file information of
a file from Google Диск.

Настройки

• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Выберите способ идентификации файла: по пути к файлу и имени или идентификатору. If this is a

shared folder, you must use the FILE ID option.

Прим.:  Идентификатор — это значение в URL-адресе после последней прямой косой
черты. For example, if the URL is https://docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is 12dlAwvrEA4JeLysfFky9

• Select or create a dictionary variable to hold the file information which is stored in two keys: the name
key holds the file name and the extension key holds the file extension.

Get file permission action in Google Диск
Use the Get file permission action in the Google Диск пакет to enable you to retrieve file permission of
a file or a folder from Google Диск.

Настройки

• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Select whether to identify the file by file path and name, or by ID.

Прим.:  Идентификатор — это значение в URL-адресе после последней прямой косой
черты. For example, if the URL is https://docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is 12dlAwvrEA4JeLysfFky9.

• Выберите или создайте переменную списка для сохранения разрешений файла.

© 2023 Automation Anywhere. All rights reserved.     1622



    Automation Anywhere - Сборка

Move file action in Google Диск
Use the Move file action in the Google Диск пакет to enable you to move file from one folder to another
on Google Диск.

Настройки

• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Select whether to identify the file by file path and name, or by ID.

Прим.:  Идентификатор — это значение в URL-адресе после последней прямой косой
черты. For example, if the URL is https://docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is 12dlAwvrEA4JeLysfFky9.

• Select whether to identify the destination folder by directory path and name, or by ID.

Прим.:  Идентификатор — это значение в URL-адресе после последней прямой косой
черты. For example, if the URL is https://docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is 12dlAwvrEA4JeLysfFky9.

Move folder action in Google Диск
Use the Move folder action in the Google Диск пакет to enable you to move a folder from one location to
another on Google Диск.

Настройки

• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Выберите способ идентификации исходной папки: по пути к папке и имени или идентификатору.

If this is a shared folder, you must use the Folder ID option.

Прим.:  Идентификатор — это значение в URL-адресе после последней прямой косой
черты. For example, if the URL is https://docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is 12dlAwvrEA4JeLysfFky9.

• Выберите способ идентификации папки назначения: по пути и имени или идентификатору.

Rename file action in Google Диск
Use the Rename file action in the Google Диск пакет to enable you to rename a file on Google Диск.

Настройки

• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Select whether to identify the file by file path and name, or by ID.

Прим.:  Идентификатор — это значение в URL-адресе после последней прямой косой
черты. For example, if the URL is https://docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is 12dlAwvrEA4JeLysfFky9.

• Введите новое имя файла.
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Rename folder action in Google Диск
Use the Rename folder action in the Google Диск пакет to enable you to rename a folder in a specific
directory on Google Диск.

Настройки

• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Select whether to identify the folder by directory path and name, or by ID.

Прим.:  Идентификатор — это значение в URL-адресе после последней прямой косой
черты. For example, if the URL is https://docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is 12dlAwvrEA4JeLysfFky9.

• Введите новое имя папки.

Upload file action in Google Диск
Use the Upload file action in the Google Диск пакет to enable you to upload a file from your computer to
Google Диск.

Настройки

• Введите то же имя пользователя, которое вы указали в поле Подключить .
• Введите путь и имя файла.
• Select whether to identify the folder where to upload the file by directory path and name, or by ID.

Прим.:  Идентификатор — это значение в URL-адресе после последней прямой косой
черты. For example, if the URL is https://docs.google.com/spreadsheets/
d/12dlAwvrEA4JeLysfFky9, the ID is 12dlAwvrEA4JeLysfFky9.

• Необязательно. Чтобы перезаписать одноименный файл, установите флажок Заменить
существующий файл.

• Необязательно. Выберите или создайте переменную для сохранения идентификатора
загруженного файла.

Google Document AI пакет
Extract data from documents by using the Google Document AI capabilities of the Google Document AI
пакет in your боты.

Перед началом работы

Create a processor in Google Document AI. Создать обработчик.
Используйте actions из пакет Google Диск в указанном ниже порядке.
1. Используйте action Подключить, чтобы установить соединение с учетной записью службы

Google Cloud.
2. Настройте action Извлечь, чтобы указать расположение для извлекаемых документов, и

предоставьте сведения о обработчике.

© 2023 Automation Anywhere. All rights reserved.     1624

https://cloud.google.com/document-ai/docs/create-processor


    Automation Anywhere - Сборка

3. Используйте action Отключить, чтобы разорвать соединение.

Действия в Google Document AI пакет

пакет Google Document AI включает в себя описанные ниже actions.

Действие Описание

Подключить Устанавливает соединение с учетной записью службы Google
Cloud.
Обеспечьте следующее:
• Путь к файлу ключа. Выберите файл JSON, содержащий

ключ учетной записи службы Google Cloud.
• Сеанс службы Google Cloud. Введите уникальное имя

для сеанса.

Извлечение Sends documents to Google Document AI for data extraction.
Using the Extract action for Google Document AI

Отключить Отключается от учетной записи службы Google.
В поле Имя сеанса введите имя сеанса, который
использовался для подключения к учетной записи службы
Google в ходе выполнения action Подключить.

Using the Extract action for Google Document AI
Configure the Extract action to enable your бот to send documents to Google Document AI for data
extraction and retrieve the output in JSON format.
Login to your Google Cloud account and go to the Processors page to retrieve your custom endpoint. See
Use your processor endpoint.
Your custom endpoint should follow this format: https://LOCATION-documentai.googleapis.com/
API_VERSION/projects/PROJECT_ID/locations/LOCATION/processors/PROCESSOR_ID. You
will need the parameters in bold to configure this action.
1. Double-click or drag the Google Document AI > Extract action.
2. In the Document file path field, provide the file path to the document you want to process.

Прим.:  If using this action within a Loop action to process all the documents in a folder, be sure to
include a period between the variable holding the file name and the one holding the extension. For
example, C:\Documents\$dictFile(name)$.$dictFile(extension)$.

3. Provide the following information, which is found in your custom endpoint.
• Project id
• Processor id
• Место проведения

4. In the Session name field, enter the name of the session you used to connect to the Google service
account in the Connect action.

5. Необязательно: Выберите или создайте значение строковой переменной для сохранения
выходного значения.
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The action returns data in JSON format.
6. Щелкните Сохранить.

You can use the actions in the JSON пакет to parse the data and extract values from specific nodes. For
an overview of how to do this, refer to the following steps:
1. Initiate the JSON session with the Start session action. In the JSON text field, insert the string

variable holding the output of the Extract action.
2. Use the Get node value action to parse the output of the Google Document AI > Extract action

and assign the node values to a list variable.
You can insert a Loop action after the Get node value action to iterate through each list item to
perform an operation on each node value.

3. Terminate the JSON session with the End session action.

Google Sheets пакет
пакет Google Таблицы содержит actions, которые позволяют автоматизировать задачи, связанные
с ячейками, столбцами, строками и листами.

Перед началом работы

Используйте actions из пакет Google Таблицы в указанном ниже порядке.
1. Используйте параметр Подключить , чтобы установить подключение с сервером Google.

См. раздел Using the Connect action for Google packages.
2. Используйте комбинацию , доступных в этом , для автоматизации задач.

Прим.:  Используйте  из других  Google, установите подключение с помощью параметра
Подключить  из этого .

3. Используйте параметр Отключить , чтобы разорвать подключение.

Действия в пакет Google Таблицы

actions в пакет Google Таблицы позволяют выполнять указанные ниже операции.

Действие Описание

Активировать лист См. раздел Activate sheet action in Google
Таблицы.

Автоподгонка столбцов См. раздел Autofit columns action in Google
Таблицы.

Автоподгонка строк См. раздел Autofit rows action in Google
Таблицы.

Закрыть См. раздел Close action in Google Таблицы.

Создать лист См. раздел Create sheet action in Google
Таблицы.
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Действие Описание

Создать книгу См. раздел Create workbook action in Google
Таблицы.

Удалить ячейку См. раздел Delete cell action in Google Таблицы.

Удалить диапазон См. раздел Delete range action in Google
Таблицы.

Удалить строку/столбец См. раздел Delete row/column action in Google
Таблицы.

Удалить лист См. раздел Delete sheet action in Google
Таблицы.

Отключить См. раздел Disconnect action.

Форматировать ячейки См. раздел Format cells action.

Получить имена всех листов См. раздел Get All Sheet Names action.

Get Cell/text color See Get Cell/text color action.

Получить имя текущего листа See Get Current Sheet Name action.

Получить несколько ячеек См. раздел Get multiple cells action in Google
Таблицы.

Получить число строк См. раздел Get number of rows action.

Получить одну ячейку См. раздел Get single cell action in Google
Таблицы.

Перейти к ячейке См. раздел Go to cell action in Google Таблицы.

Скрыть лист См. раздел Hide worksheet action.

Вставить ячейку См. раздел Insert cell action.

Вставить диапазон See Insert range action.

Вставить строку/столбец См. раздел Insert row/column action in Google
Таблицы.

Открыть электронную таблицу См. раздел Open spreadsheet action in Google
Таблицы.

Вставить ячейку См. Paste cell action

Прочитать формулу ячейки См. Read cell formula action

Прочитать столбец См. раздел Read column action in Google
Таблицы.

Прочитать строку См. раздел Read row action in Google Таблицы.

Переименовать таблицу См. раздел Rename sheet action.

Retrieve Sheets count See Retrieve Sheets count action.

Задать ячейку См. раздел Set cell action in Google Таблицы.

Задать формулу ячейки См. Set cell formula action

Set cell or text color См. Set cell or text color action

Показать лист См. Show worksheet action
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Действие Описание

Записать из таблицы данных См. раздел Write from data table action in Google
Таблицы.

Activate sheet action in Google Таблицы
Activate sheet action enables you to activate a specific sheet in the open spreadsheet.

Настройки

Активация определенного листа в открытой электронной таблице.
• Введите имя сеанса, используемого для открытия текущей электронной таблицы с

использованием action Открыть электронную таблицу.
• Укажите, как следует активировать лист: в соответствии с индексом или именем.

Прим.:  Подсчет индексов листов начинается с 1.

Autofit columns action in Google Таблицы
Autofit columns action enables you to resize the columns that contain data to accommodate the data.

Настройки

Изменение размера столбцов, содержащих данные, для размещения данных. Введите имя сеанса,
используемого для открытия текущей электронной таблицы с использованием action Открыть
электронную таблицу.

Autofit rows action in Google Таблицы
Autofit rows action enables you to resize the rows that contain data to accommodate the data.

Настройки

Изменение размера строк, содержащих данные, для размещения данных. Введите имя сеанса,
используемого для открытия текущей электронной таблицы с использованием action Открыть
электронную таблицу.

Close action in Google Таблицы
With Close action, you can save and close the current spreadsheet.

Настройки

Сохранение и закрытие текущей электронной таблицы. Введите имя сеанса, используемого для
открытия текущей электронной таблицы с использованием action Открыть электронную таблицу.
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Create sheet action in Google Таблицы
Create sheet action enables you to create a new sheet in the open workbook.

Настройки

Создание нового листа в открытой книге.

• Введите имя сеанса, используемого для открытия текущей электронной таблицы с
использованием  Открыть электронную таблицу.

• Укажите, как следует создавать лист: в соответствии с индексом или именем.

Прим.:  Подсчет индексов листов начинается с 1.

Create workbook action in Google Таблицы
Create workbook action enables you to create a new workbook in your Google Таблицы.

Настройки

Creates a new Google Таблицы workbook.
• Введите имя пользователя, которое вы использовали в action Подключить.
• Введите имя сеанса, используемого для открытия текущей электронной таблицы с

использованием  Открыть электронную таблицу.
• Введите имя книги с одним из указанных ниже расширений файлов. .xlsx, .xls или .xlsm
• Введите путь к файлу для новой книги или выберите файловую переменную.

Delete cell action in Google Таблицы
Delete cell action enables you to delete cells within a worksheet.

Настройки

Удаление ячейки в листе.
• Введите имя сеанса, используемого для открытия текущей электронной таблицы с

использованием  Открыть электронную таблицу.
• Выберите либо параметр Активная ячейка, либо параметр Определенная ячейка. Если вы

выбрали Определенная ячейка, введите адрес ячейки.
• Выберите один из указанных ниже параметров удаления.

• Сдвинуть ячейки влево
• Сдвинуть ячейки вверх
• Вся строка
• Весь столбец

Delete range action in Google Таблицы
Delete range action enables you to delete a range of cells.
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Настройки

Deletes a range of cells.
• Введите имя сеанса, используемого для открытия текущей электронной таблицы с

использованием  Открыть электронную таблицу.
• Введите адрес диапазона. For example A1:B4.
• Выберите направление, в котором нужно сдвинуть оставшиеся активные ячейки: Вверх или

Влево.

Delete row/column action in Google Таблицы
Delete row/column action enables you to delete a row or column in a worksheet.

Настройки

Удаление строки или столбца в таблице.
• Введите имя сеанса, используемого для открытия текущей электронной таблицы с

использованием  Открыть электронную таблицу.
• Выберите, для чего должна быть выполнена операция: для строки или для столбца.
• Укажите, как следует удалять лист: в соответствии с индексом или именем.
• Укажите, как следует выполнять удаление: в соответствии с индексом, активной ячейкой или

диапазоном.
• Если вы выбрали индекс, введите индекс строки/столбца

Прим.:  Подсчет индексов начинается с 1.

• Если вы выбрали диапазон, укажите диапазон строк/столбцов для удаления. For example 1:10
to delete the first ten rows.

Delete sheet action in Google Таблицы
Use the Delete sheet action in the Google Таблицы пакет to delete a sheet from a workbook.

Настройки

• Введите имя сеанса, используемого для открытия текущей электронной таблицы с
использованием  Открыть электронную таблицу.

• Укажите, как следует удалять лист: в соответствии с индексом или именем.

Disconnect action
The Disconnect action terminates the connection with the Google Таблицы app. Enter the session name
that you used in the Connect action. Add this action at the end of automation sequences that use actions
from this Google Таблицы пакет.

Настройки

• In the Username field, you can provide a valid username or select the credential or credential variable
that contains your Google username. To enter a value, click Insecure string.
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• Enter the session name that you used in the Connect action.
• Select the check box Logout from the browser if you want to sign off from your account.

Format cells action
The Format cells action enables you to format specific cells of a workbook.

Настройки

• Enter the session name that you used in the Connect action.
• Use the Cell options field to select one of the following format options:

• Active cell: Is the default selection and is used to format the current or active cell from the
workbook.

• Specific cell: Use the Cell Name field to enter the name of the cell from the workbook.
• Multiple cells: Use the Cell range filed to specify the range for of all the cells from the workbook

that you want to format.

• (Optional) Select Font check box to change the font specifications of the content such as name, size
and color.

• (Optional) Select Alignment check box to change the vertical or horizontal alignment of the content.
• (Optional) Select Wrap Text check box to change the default text wrap option of the content.
• (Optional) Select Merge Type check box to choose from various merge options.

Get All Sheet Names action
The Get All Sheet Names action enables you to retrieve the names of all the sheets within a specific
workbook and store it as a variable.

Настройки

• Enter the session name that you used in the Connect action.
• Use the Store All Sheet Names to field for one of the following options:

• Select an existing variable from the Choose a variable drop-down menu.
• Click Create variable icon for a new variable.

Use the Create Variable screen to enter a name, variable type (input or output), and a subtype.

Get Cell/text color action
Use the Get cell/text color action to get the color of the background or text in a cell. This action
retrieves the color of a cell as RGB values. For example, if the background or text in a cell is of red color,
the value retrieved is 255,0,0.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• To get the color from the current active cell, select Active cell, or, to get the color from a specific cell,

select Specific cell.
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• Specify the cell name or address in the Cell name.
• to get the background color of the cell, select Cell Color.
• To get the color of the text, or both, select Text Color.
• Specify whether to retrieve the cell color by Name or Code.
• To assign the cell/text color to a List variable, select one of the options from the Assign the output to

variable drop-down.

Get Current Sheet Name action
The Get Current Sheet Nameaction for the Google Таблицы package enables you to retrieve the name
of the current worksheet in a workbook.

Настройки

• Enter the session name or select an existing variable used in the Session name field.
• In the Store Current Sheet Name to field, enter the destination to store the current sheet or select it

from the variables.

Get multiple cells action in Google Таблицы
Use the Get multiple cells action in the Google Таблицы пакет to retrieve values from cells in a Google
sheet and store them in a table variable.

Настройки

• Введите имя сеанса, используемого для открытия текущей электронной таблицы с
использованием  Открыть электронную таблицу.

• Select the Multiple cells option to retrieve values from a range of cells, or select All cells to retrieve
values from all cells.

• Выберите или создайте переменную таблицы для сохранения выходного значения.

Get number of rows action
The Get number of rows action in the Google Таблицы пакет enables you to get the number of rows
that are not empty or contain data.

Настройки

• Введите имя сеанса, используемого для открытия текущей электронной таблицы с
использованием action Открыть электронную таблицу.

• Select the Non-empty rows option to get the number of rows that are not empty or the Total rows
with data option to get the number of rows that contain data.

• Select the number variable from the Assign output to a variable field to store the output.

Get single cell action in Google Таблицы
Use the Get single cell action in the Google Таблицы пакет to retrieve the value from a specific cell in a
Google sheet and store it in a string variable.
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Настройки

• Введите имя сеанса, используемого для открытия текущей электронной таблицы с
использованием  Открыть электронную таблицу.

• Выберите либо параметр Активная ячейка, либо параметр Определенная ячейка. Если вы
выбрали Определенная ячейка, введите адрес ячейки.

• Выберите или создайте значение строковой переменной для сохранения выходного значения.

Go to cell action in Google Таблицы
Use the Go to cell action in the Google Таблицы пакет to go to the specified cell.

Настройки

• Введите имя сеанса, используемого для открытия текущей электронной таблицы с
использованием  Открыть электронную таблицу.

• Select a Cell Options. Если вы выбрали Определенная ячейка, введите адрес ячейки.
Например, B4.

Hide worksheet action
The Hide worksheet action in the Google Таблицы пакет enables you to hide a worksheet from the
current workbook.

Настройки

• In the Worksheet name field, specify the name of the worksheet to hide.

Прим.:  Вы можете скрыть лист, только если книга содержит более одного листа.

• Enter the name of the session that you used to open the workbook with the Open spreadsheet
action.

Insert cell action
The Insert cell action enables you to insert a cell at a specific point in a workbook by shifting any existing
cell.

Настройки

• Enter the session name that you used in the Connect action.
• Use the Cell options field to select one of the following format options:

• Active cell: Is the default selection and is used to format the current or active cell from the
workbook.

• Specific cell: Use the Cell Name field to enter the name of the cell from the workbook.

• Use the Shift type field to select how an existing cell must be shifted.
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Insert range action
The Insert range action of the Google Таблицы package enables you to insert the range into the current
worksheet without overwriting the existing value.

Настройки

• Enter the session name or select an existing variable used in the Session name field .
• Enter the cell range in the Range address. For example A1:B4. This inserts a range of cells consisting

of the first four rows by the first two columns.
After inserting the cell, set the Shift type to Down to shift the existing values down by the specified
number of rows. Or Right to shift the existing values right by the specified number of columns.

Insert row/column action in Google Таблицы
Use the Insert Row/Column action in the Google Таблицы пакет to insert a blank row or column into a
spreadsheet.

Настройки

• Введите имя сеанса, используемого для открытия текущей электронной таблицы с
использованием  Открыть электронную таблицу.

• Выберите, что нужно вставить, строку или столбец.
• If you chose Row Operations, select whether to insert the row at a specific index, above the active

cell, or in a range.

Прим.:  Подсчет индексов начинается с 1.

• If you chose Column Operations, select whether to insert the column at a specific address, to the
left of the active cell, or in a range.

Open spreadsheet action in Google Таблицы
Use the Open spreadsheet action in the Google Таблицы пакет to open an existing spreadsheet.

Настройки

• In the Username field, enter the same username that you provided in the Connect action.
• Введите имя сеанса. Используйте это имя сеанса в последующих actions, чтобы связать их с этой

электронной таблицей.
• Выберите способ открытия электронной таблицы: по имени, URL-адресу или идентификатору

электронной таблицы.
• Имя. Введите имя файла.
• URL-адрес. Введите полный URL-адрес.
• Идентификатор электронной таблицы. Идентификатор — это значение в URL-адресе

после последней прямой косой черты. For example, if the URL is https://docs.google.com/
spreadsheets/d/12dlAwvrEA4JeLysfFky9, the ID is 12dlAwvrEA4JeLysfFky9.
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• Если электронная таблица содержит несколько листов, выберите параметр Имя определенного
листа и введите имя листа.

Paste cell action
The Paste cell action in the Google Таблицы пакет enables you to copy a value from a cell and pastes to
a specified cell.

Настройки

• Введите имя сеанса, используемого для открытия текущей электронной таблицы с
использованием action Открыть электронную таблицу.

• Select the Active cell or Specific cell option to specify the cell from which to read the format. If you
have selected the Specific cell option, enter the cell name and specify the address of the cell in the
field.

Read column action in Google Таблицы
Use the Read column action in the Google Таблицы пакет to retrieve data from a column and store it in
a list variable.

Настройки

• Введите имя сеанса, используемого для открытия текущей электронной таблицы с
использованием  Открыть электронную таблицу.

• In the Cell options field, specify the cell location from which to read the values. Например, введите
A5, чтобы извлечь все значения, расположенные в первом столбце ниже пятой строки.

• Можно также выбрать параметр Прочитать весь столбец, чтобы извлечь значения из всего
столбца.

• Выберите или создайте переменную списка для сохранения выходного значения.

Read row action in Google Таблицы
Use the Read row action in the Google Таблицы пакет to retrieve data from a row and store it in a list
variable.

Настройки

• Введите имя сеанса, используемого для открытия текущей электронной таблицы с
использованием  Открыть электронную таблицу.

• In the Cell options field, specify the cell location from which to read the values. For example, enter D5
to retrieve the values located in the fifth row and right of the fourth column.

• Можно также выбрать параметр Прочитать весь ряд, чтобы извлечь значения из всей строки.
• Выберите или создайте переменную списка для сохранения выходного значения.

Read cell formula action
The Read cell formula action in the Google Таблицы пакет enables you to retrieve the formula available
in the Active cell or Specific cell and assign the output to a string variable. This action returns a blank
value if the specified cell does not contain a formula.

© 2023 Automation Anywhere. All rights reserved.     1635



    Automation Anywhere - Сборка

Настройки

• Enter the name of the session that you used to open the workbook with the Open spreadsheet action
• Select the Active cell or Specific cell option to specify the cell from which to read the formula.

Прим.:  If you have selected the Specific cell option, specify the address of the cell in the field.

• In the Assign the output to variable field, select a string variable to store the name of the formula.
В  отображается описательное имя переменной по умолчанию. If you create several output
variables, subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

Rename sheet action
The Rename sheet action enables you to rename a specific sheet of a workbook.

Настройки

• Enter the session name that you used in the Connect action.
• Use the Sheet field to select one of the following format options:

• Index: Use this option to select an index that must be renamed.
• Name: Use this option and enter the name of the sheet that you want to rename.

• Use the Enter new name for the sheet field to enter a name that must be added.

Retrieve sheets count action
The Retrieve sheets count action of the Google Таблицы package enables you to get the number of
sheets available in the current workbook and store it in a number variable

Настройки

• Enter the session name or select an existing variable used in the Session name field.
• Select the Exclude Hidden Worksheets option to exclude the hidden worksheet or not and assign

the count to a variable.
• From the Assign the output to a variable listdrop-down, specify the variable to which you want to

assign the output.

Set cell action in Google Таблицы
Use the Set cell action in the Google Таблицы пакет to set the value of a specific cell.

Настройки

• Введите имя сеанса, используемого для открытия текущей электронной таблицы с
использованием  Открыть электронную таблицу.

• Введите адрес ячейки. For example, A5.
• Выберите или создайте значение строковой переменной для сохранения значения ячейки.
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Set cell formula action
The Set cell formula action of the Google Таблицы пакет enables you to set a formula in the active cell or
a specific cell in a Google sheet.

Настройки

• Enter the name of the session used to open the workbook with the Open spreadsheet action.
• Select the Active cell, Specific cell, or Multiple cells option to specify the cell in which you want to

set the formula.

Прим.:
• If you have selected the Specific cell option, specify the address of the cell in the Cell name field.
• If you have selected Multiple cells option, specify the range of the cells in the Cell range field.

• Enter the value to set in the Cell formula field without an "=".

Set cell or text color action
The Set cell or text color action of the Google Таблицы пакет enables you to set the color of the
background or text in a cell. This action sets the color of a cell as RGB values. For example, if you want to
set red color to the background or text in a cell, enter the value 255,0,0.

Настройки

• Enter the name of the session used to open the workbook with the Open spreadsheet action.
• To set the color to the current active cell, select Active cell, to set the color to a specific cell, select

Specific cell, or to set the color to multiple cells select Multiple cells.

Прим.:
• If you have selected the Specific cell option, specify the address of the cell in the Cell name field.
• If you have selected Multiple cells option, specify the range of the cells in the Cell range field.

• In the Set color to field, to apply color to the background area of the cell, select the Cell option. To
apply color to the text within a specific cell, select the Text within cell option.

• In the Cell color by Name/Code field, specify whether you want to set the cell color by name or as
an RGB value or choose a variable that has the value.

Show worksheet action
The Show worksheet action in the Google Таблицы пакет enables you to show a hidden google sheet in
a worksheet.

Настройки

• Введите имя сеанса, используемого для открытия текущей электронной таблицы с
использованием action Открыть электронную таблицу.

• Enter the worksheet name in the Google sheet name field.
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Прим.:  The sheet name should not exceed 31 characters.

Write from data table action in Google Таблицы
Use the Write from data table action in the Google Таблицы пакет to write the contents of a data table
variable to a specific spreadsheet.

Настройки

• Введите имя сеанса, используемого для открытия текущей электронной таблицы с
использованием  Открыть электронную таблицу.

• Выберите, следует ли выполнять запись на активный в данный момент лист, или укажите имя
листа.

• Выберите переменную таблицы данных.
• Введите адрес ячейки, с которой следует начать запись данных.

IBM Watson Authentication пакет
The IBM Watson Authentication пакет contains actions that enable you to authenticate the API token
and location URL for each service, while connecting to and disconnecting from your IBM Cloud account.
With this пакет, you only have to provide your credentials once.

Важное замечание:  This is a beta пакет and is currently not available with the Automation 360
Enterprise and Cloud editions.

Перед началом работы
Each service requires a unique API key and location URL. Log in to your IBM Cloud account to create an
instance of the service to obtain the API Key and location URL. Automation 360 currently includes Speech to
Text.

Действия in the IBM Watson Authentication package

Действие Описание

Подключить Establishes a connection with the IBM Cloud account. Insert this
action at the beginning of automation sequences that use IBM
Watson пакеты so that you have to input the credentials only
once. To use this action, select the services to connect with, then
provide the API Key and URL for each service you will use.

Отключить Terminates the connection with the IBM Cloud account. Insert this
action at the end of automation sequences that use IBM Watson
пакеты.
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IBM Watson Speech to Text пакет
This пакет supports the following audio file formats: flac, mpeg, mp3, ogg, pcm, wav, and webm. The
following languages are supported: Arabic, Brazilian Portuguese, Chinese (Mandarin), English (United
Kingdom and United States), French, German, Japanese, Korean, Spanish (Argentinian, Castilian, Chilean,
Colombian, Mexican, and Peruvian).

Важное замечание:  This is a beta пакет and is currently not available with the Automation 360
Enterprise and Cloud editions.

Функция Описание

Detect speakers Identifies the individuals in a conversation between multiple people.
• Supports English, Japanese, and Spanish.
• Use for conversation between two people; maximum six people.
• For best results, use an audio file at least a minute long.

The output contains the words spoken by each speaker and the
timestamp.

Keyword spotting Detects specific strings in the transcript. The output contains the
timestamp(s) for each keyword and a confidence score.

Smart formatting Converts the following types of strings into more conventional
representations to make the transcript easier to read:
• Dates
• Число раз
• Series of digits and numbers
• Phone numbers
• Currency values
• Email and web addresses

For examples, see Smart formatting results. This feature supports
English, Japanese, and Spanish.

Profanity filter Obscures profanity by replacing it with asterisks in the transcript.

Если пакет
Use the actions in the Если пакет to control the sequence of execution based on one or more conditions
of a task.
Use the actions in the Если пакет to check whether an application is running, a folder or file exists, a
variable matches the specified value, an application window exists, or a machine or server is running
before executing a set of actions.

Действия в Если пакет

пакет Если включает в себя указанные ниже actions.
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Действие Описание

Если См. Если пакет

Else if (optional) См. Else if (optional) action

Else См. Else action

Conditions in the Если action

Use the following conditions in the If action to control the flow of execution in an automation task:

Условие Описание

Приложение Use the Application is running or Application is not running
condition to run actions based on whether an application is running or not
running.
Enter the application path or specify the path using a variable along with
the amount of time to wait (in seconds) for the condition to be true.

Прим.:  The Application is running and Application is not running
conditions are not applicable for Internet Explorer боты because its
corresponding process iexplore.exe runs in the background when
Microsoft Edge is launched in IE mode.

Логический Use the Boolean variable condition to execute actions based on whether
a Boolean variable contains the value True or False.
You can also use this condition to compare the values of two Boolean
variables by selecting the second variable from the Insert a Variable
window.

Data table Use the Data table is empty condition to execute actions based on
whether the specified table contains values.
Use the Number of rows and Number of columns conditions to
execute actions based on whether the number of columns or rows is
Equal to, Greater than, or Less than the specified value.

Дата/время Use the Datetime variable condition to execute actions based on
whether the value of the source datetime variable is Equal to or Not
Equal to, is Greater than or Equal to, or is Lesser than or Equal to
the value of the target datetime variable.

Словарь Use the Check key condition to execute actions based on whether the
value of the specified key is Equal to or Not equal to, or Contains or
Does not contain the target value.

Прим.:  The key comparison is case-sensitive.

Use the Check for a single value condition to execute actions based on
whether a specific key contains the target value.

DLL Use the Dll session exists and Dll session does not exist condition to
execute actions based on whether a Dll session is open or closed in a бот.
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Условие Описание

Файл Use the following conditions to execute the action:
• File date

Use this condition to verify the date and time when a file was created
or modified. Specify a date or date range using the On a date, Is
within last, Is between, or Is before options. For the On a date
option, specify a date to verify whether the file was created or modified
on that date. For the Is within last option, specify the number of days
or time (in hours, minutes, and seconds). Enter the amount of time (in
seconds) to wait for this condition to be true.

• File exists and File does not exist
Use these conditions to execute an action based on whether a file
exists. For example, if a data file exists, format the file and upload it to
a database.

• File extension
Use this condition to check the file extension of a selected file and then
execute actions based on the results. Use the File path field to select a
file.

• File size
This condition verifies if the specified file is larger, smaller, not the
same, or the same as the size you specify.
Enter the amount of time (in seconds) to wait for this condition to be
true.

Папка Use the Folder exists or Folder does not exist condition to execute an
action based on whether a folder exists.

Распознавание
изображений

Use these conditions to verify whether:
• Image file is found in the Image file or not.
• Image file is found in the Window or not.
• Window is found in the Image file or not.
• Window is found in the Window or not.

For the Window conditions, you can use the Resize window option to
specify the window dimensions. This option delivers a more reliable бот.
It resizes the window to the dimensions at which the task was recorded,
which enhances the bot's ability to identify the target object.

Прим.:  This option is only available for windows that can be resized. It is
not available for Desktop or Taskbar options.

For the Window conditions, you can use the Preview option to select a
specific captured occurrence and position your click location relative to the
image.

JavaScript Use the Script is successful or Script is unsuccessful condition to
execute actions based the status of the specified JavaScript. Select the file
that contains the script and optionally specify the parameters by selecting
a list variable.
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Условие Описание

Автоматизация
предыдущих версий

The Legacy automation conditions are only used in migrated боты
to ensure that they run seamlessly in Automation 360. We do not
recommend using these conditions for new бот development. The
following conditions to verify the following:
• Whether Web control exists or not.
• Whether Window control exists or not.
• Whether Window control is active or not.
• Whether Script is successful or not.
• Whether Child window exists or not.

For the Window control conditions, you can use the Resize window
option to specify the window dimensions. This option delivers a more
reliable бот. It resizes the window to the dimensions at which the task was
recorded, which enhances the bot's ability to identify the target object.

Список Use the List variable condition to execute actions based on whether
the specified list variable contains a particular value. The value can be of
Number, String, or Boolean data type.

Число Use the Number variable condition to execute actions based on whether
the specified number variable is Equal to or Not Equal to, or is Greater
than or Equal to, or is Lesser than or Equal to a particular value.

Ping Use the Ping is successful or Ping is unsuccessful condition to verify
if a machine or server is running, and execute actions based on the result.
Enter the amount of time (in seconds) to wait for the condition to be true.

Средство записи • Use the Object exists condition to detect an object in a window.
Select a window or variable to capture the object. Enter the amount of
time (in seconds) to wait for this condition to be true, that is, for the
object to be detected.

• Use the Object does not exist condition to verify whether a specific
object exists in a window, and then based on the result, execute
actions. Enter the amount of time (in seconds) to wait for this condition
to be true. For example, you can use the Object does not exist
condition inside the Loop > While condition to make sure that the
бот does not execute the next action until the object on the business
application is loaded.

Прим.:  The Object exists and Object does not exist Recorder
conditions support Chromium-based Microsoft Edge with Internet Explorer
mode.

Служба Use the Service is running or Service is not running condition to
execute actions based on whether a service is running or not. Select
Service list to choose a service from the list of available services.
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Условие Описание

Строка Use the String variable condition to execute actions based on whether
the specified source string value is Equal to or Not equal to, or
Includes or Does not include the target value.
You can select the Match case option to only execute actions if the two
strings have matching uppercase and lowercase letters.
When you extract text from a Microsoft application, the extracted text
contains the /r/n special characters which indicate a new line. Select
the Ignore Carriage return option if you want to ignore the /r special
character when you compare the text.
To create a condition based on whether a string is empty or not empty,
compare the source value to an empty target field using the Equal to
operator.
См. раздел Example of using a conditional statement.

TaskBot Use the Task successful or Task unsuccessful condition to execute
actions based on the status of the specified TaskBot.

VBScript Use the Script is successful or Script is unsuccessful condition
to execute actions based on the status of the specified Visual Basic
script. Select the file that contains the script and optionally specify the
parameters by selecting a variable.

Окно Use the Window exists or Window does not exist condition to verify
if a specific application window is open by entering the Window title or
using a variable. Enter the amount of time (in seconds) to wait for the
condition to be true. These conditions are used when the window title
remains constant and to verify if the specific window is open and execute
further actions based on the output.
Use the Window with same title does not exist or Window with
same title exist condition to verify whether a window with the same title
exists or whether the window title has changed. Enter the amount of time
(in seconds) to keep verifying if the condition is true. These conditions are
used for window titles that are dynamic. For example, when you open a
Google account webpage, enter your username and password to log into
your account, the window title changes. If you want to compose a new
email as a next action, you can use these conditions before you execute
the next action to verify if the window with the same title exists or if the
title has changed.

Пример
Build a basic бот that uses a desktop application

An example of how to build a basic TaskBot that uses the Если пакет.

If action
The If action in the Если package enables you to specify a condition and hold a sequence of actions to run
if the condition is true.
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Настройки

You can configure multiple conditions within a single If action.
1. Click Add condition.
2. Select either of the following options:

• And: Both of the conditions must be met for the  to run.
• Or: Either of the conditions must be met for the  to run.

3. Select the condition from the drop-down list.

См. раздел Using If action.
Using If action
Use the If Else If and If Else actions to change the flow of execution in an automation task based on
certain conditions.
To use the actions in the If package, do the following:
1. Double-click or drag the If action from the If package in the Actions palette.
2. Select the required condition from the Condition list.

See Если пакет for a list of available conditions.
3. Drag the actions to be executed if the condition is satisfied within the If condition.
4. Double-click or drag the Else If action from the If package in the Actions palette to include

alternative actions to run if the condition for the If action is false, and if the condition for the Else If
action is true.

5. Drag the actions to be executed if the condition is satisfied within the Else If condition.
6. Double-click or drag the Else action from the If package in the Actions palette to include actions to

run if the conditions for the If and Else If actions are false.
7. Drag the actions to be executed if the condition is satisfied within the Else condition.
8. Щелкните Сохранить.

Else if (optional) action
The Else if (optional) action in the Если package enables you to specify an alternative condition to test if
the condition specified in the If action is false.

Настройки

If this alternative condition is true, the бот runs the sequence of actions contained within the Else if
action.
You can configure multiple conditions within a single Else if action.
1. Click Add condition.
2. Select either of the following options:

• And: Both of the conditions must be met for the  to run.
• Or: Either of the conditions must be met for the  to run.

3. Select the condition from the drop-down list.
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Else action
The Else action in the Если package enables you to specify the alternative sequence of actions.

Настройки

Specifies the alternative sequence of actions if the condition specified in the Если action and Else if action
(if used) is false.

Image Recognition пакет
The Image Recognition пакет contains actions that enable you to search for a user interface (UI)
element in an application based on an image to automate a task in that application.

Действия in the Image Recognition пакет

Use these actions to automate a task when it is not possible to capture UI elements of applications that
are:
• Exposed over Citrix
• Accessed using the Remote Desktop Protocol (RDP)
• Developed using legacy technology

Image recognition is also useful when object-based recognition does not work or is unreliable. For
example, you can use an image to search for the Close button in an application and perform a left-click
operation.
The Image Recognition пакет contains the following actions:

Действие Описание

Найти изображение в окне См. раздел Using Find image in window action.

Поиск окна в окне См. раздел Using the Find window in window
action.

Безопасная запись

When secure recording mode is enabled, боты display only the target image but not the source image. Это
гарантирует, что конфиденциальные данные не будут показаны. To see a preview of the source image
in the Preview window, click the Preview button.

Прим.:  The target images are still stored in the Control Room because they are required to run the боты.

Этот параметр должен быть включен пользователем с полномочиями администратора. См. раздел
Настройки.

Безопасная запись

Если включен режим безопасной записи, боты не отображают изображения целевых объектов после
съемки. Это гарантирует, что конфиденциальные данные не будут показаны.
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Прим.:  Несмотря на то, что боты не отображают целевые изображения после записи, изображения
все еще хранятся в памяти Control Room, потому что они необходимы для запуска боты.

Когда вы записываете задание в режиме безопасной записи, в окне Предварительный просмотр
временно отображается изображение захваченной области. Это изображение будет скрыто после
того, как вы переместитесь за пределы окна Bot editor или обновите его.
Этот параметр должен быть включен пользователем с полномочиями администратора. См. раздел
Настройки.
Ссылки, связанные с данной
Screen resolution dependent пакеты
The screen resolution between the Bot Runner and Bot Creator device should be consistent as when
resolution-dependent пакеты are used to build боты, any screen resolution difference between the Bot
Creator and Bot Runner device will impact the боты during runtime.

Using Find image in window action
Use the Find image in window action to search for a UI element in an application window (haystack)
using a target image (needle). The target image is an existing image that you can use to search for a UI
element.
To find an image inside an application window, follow these steps:
1. Double-click or drag the Find image in window action from the Image Recognition пакет in the

Actions palette.
2. Specify the target image (needle) that you want to find in the application window.

• Control Room file: Uses an image file that is available on the Control Room.
• Desktop file: Uses an image file that is available on your device.
• Переменная. Uses a file variable to specify the location of the image file you want to use.

Прим.:  Images of .jpeg, .jpg, .jpe, .jfif, .bmp, .png, and .gif formats are supported.

3. Specify the window in which you want to find the source image (haystack):
Choose from the Application, Browser, or Variable tab.
Вариант Описание

Приложение Select from a list of currently active windows.
This option shows a list of all the application
and browser windows that are open on the Bot
Creator device.

Браузер Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based
, and  browsers. For all other browsers, use the
Application option.

Переменная Выберите существующую переменную окна,
чтобы задать заголовок в заголовке окна
приложения.

Вставьте символ подстановочного знака (*) в поле Заголовок окна для поиска заголовков
окон, которые могут меняться. You can specify one or more wildcards (*) at the start, middle, or
end of the value.For example, to perform an operation on any window that has Microsoft in the
title, use a wildcard to indicate any string by adding it before or after the value: *Microsoft*. The 
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first searches for the exact window title (Microsoft), and if it does not find a match, it searches for
windows with the term Microsoft anywhere in the title.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

4. Необязательно: Select the Resize window option to specify the window dimensions.
This option delivers a more reliable бот. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the ботto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Прим.:  This option is available only for windows that can be resized. It is not available for the
Desktop or Taskbar options.

5. Click Capture region.
The selected window appears.

6. Drag the mouse to select the area and right-click when done.
The captured area appears in the Preview section with the image coordinates underneath.

7. In the Wait in ms before capturing the image field, specify the delay (in milliseconds) before
searching for the image.

8. Select the Repeat if image not found check box if you want the system to retry searching for the
target image if it is not found.
a) In the Times field, specify the number of times the system must repeat the process to find the

target image.
b) In the Wait between repeats (ms) field, specify the time period the system must wait before

repeating the process of finding the target image.
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9. In the Match percentage field, specify the acceptable percentage of matching pixels between the
two images.
For example, if you specify 20 in the field as the match percentage, the system considers the images
as matching even if there is up to 80% of pixel mismatch between the two images.

10. In the Selected match number field, enter a value to specify the occurrence of the target image on
which you want to perform this action.
You can insert a variable when you do not know the number of times the image might appear on the
screen. Ensure you assign variables that support numeric values.

11. Use the Preview option if you want to select an image that is relative (offset) to the existing target
image you are searching on the application screen, or you want to select a specific occurrence if there
are multiple occurrences of the target image.

12. Щелкните Предварительный просмотр.
If a target image occurs multiple times in the Preview window, each occurrence is highlighted in a
rectangular box and displays a number against each occurrence.

13. Select the specific highlighted occurrence, and you can position your click location relative to an
existing image.

Прим.:  If there are multiple images on an application screen that you are automating and when the
target image is not easily searchable; in that case, you can select an easily identifiable image in the
captured region and position your click relative to it.

14. If the target image is found multiple times in the captured region. In that case, you can select the
occurrence of a particular target image or select the occurrence number from the drop-down in the
Match number (optional) field on the right pane.
The Match number (optional) and the Target Offset fields on the right pane display the image
occurrence you selected and its offset coordinates of the target image.

15. Щелкните Отправить.
16. In the Target coordinate selections field, the coordinate options Center of match or Offset

from match will be selected automatically based on the action you performed in the Preview
window.
• Center of match: The image is selected based on the coordinates at the center of the matched

image.
• Offset from match: The image is selected based on the coordinates relative to that of the

matched image.

Прим.:  The offset coordinates measure the number of pixels from the top left corner of the image.

17. Select an option from the Action to take on target coordinates list to specify the action you want
to perform on the matched image in the application window.

18. Щелкните Сохранить.

Using the Find window in window action
Use the Find window in window action to search for a UI element in an application window using a
screenshot of a window. This action enables you to capture an image of a UI element in an application and
use the captured image to search for that UI element in another window.
To use an image available in an application window to find an image in another application window, follow
these steps:
1. Double-click or drag the Find image in window action from the Image Recognition пакет in the

Actions palette.
2. Specify the target image (needle) that you want to find in the application window.
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Вариант Описание

Браузер Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based
, and  browsers. For all other browsers, use the
Application option.

Приложение Select from a list of currently active windows.
This option shows a list of all the application
and browser windows that are open on the Bot
Creator device.

Вы можете использовать регулярное выражение (regex) для идентификации заголовка
окна. Выберите регулярное выражение в виде строки или шаблона для каждого условия
регулярного выражения и введите значение. По умолчанию поле Заголовок окна
чувствительно к регистру. You can enable Case insensitive regex flag to identify a window title
that is not case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

3. Click Capture image to capture the target image.
4. Drag the mouse pointer over an area of the application window.

The captured area appears in the Preview section.
5. Specify the window in which you want to find the source image (haystack):

Choose from the Application, Browser, or Variable tab.
Вариант Описание

Приложение Select from a list of currently active windows.
This option shows a list of all the application
and browser windows that are open on the Bot
Creator device.

Браузер Select from a list of Google Chrome tabs that are
currently open on the Bot Creator device.

Прим.:  Currently, this option only supports
Google Chrome tabs. For all other browsers, use
the Application option.

Переменная Выберите существующую переменную окна,
чтобы задать заголовок в заголовке окна
приложения.

Insert a wildcard character (*) in the Window title field to search for window titles that can change.
You can specify one or more wildcards (*) at the start, middle, or end of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The бот first searches for
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the exact window title (Microsoft), and if it does not find a match, it searches for windows with the
term Microsoft anywhere in the title.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка
окна. Выберите регулярное выражение в виде строки или шаблона для каждого условия
регулярного выражения и введите значение. По умолчанию поле Заголовок окна
чувствительно к регистру. You can enable Case insensitive regex flag to identify a window title
that is not case-sensitive.You can enable the Case sensitive option to identify a static window or
browser title and a title with a wildcard character that is case-sensitive and disable the option to
identify a window title that is not case-sensitive.
For example, you can enter the String value as ((\w*)-Notepad for all the window title names
starting with ((\w*)-Notepad, or use Pattern such as ((\w)\s)*document-Notepad for only
those window titles that match this pattern.

6. Select the Resize window option to specify the window dimensions.
This option delivers a more reliable бот. It resizes the window to the dimensions at which the task was
recorded, which enhances the bot's ability to identify the target object.
• If the window is maximized when you record the task, this option is unselected.
• If the window is not at the maximum size when you record the task, this option is selected by

default and the width and height fields auto-fill with the window dimensions.

Прим.:  This option is only available for windows that can be resized. It is not available for the
Desktop or Taskbar options.

7. Click Capture region.
The selected window appears.

8. Drag the mouse to select the area and right-click when done.
The captured area appears in the Preview section with the image coordinates underneath.

9. In the Wait in ms before capturing window field, specify the delay (in milliseconds) before
searching for the image.

10. Select the Repeat if image not found check box if you want the system to retry searching for the
target image if it is not found.
a) In the Times field, specify the number of times the system must repeat the process to find the

target image.
b) In the Wait between repeats (ms) field, specify the time period the system must wait before

repeating the process of finding the target image.

11. In the Match percentage field, specify the acceptable percentage of matching pixels between the
two images.
For example, if you specify 20 in the field as the match percentage, the system considers the images
as matching even if there is up to 80% of pixel mismatch between the two images.

12. In the Selected match number field, enter a value to specify the occurrence of the target image on
which you want to perform this action.
You can insert a variable when you do not know the number of times the image might appear on the
screen. Ensure you assign variables that support numeric values.

13. Use the Preview option if you want to select an image that is relative (offset) to the existing target
image you are searching on the application screen, or you want to select a specific occurrence if there
are multiple occurrences of the target image.

14. Щелкните Предварительный просмотр.
If a target image occurs multiple times in the Preview window, each occurrence is highlighted in a
rectangular box and displays a number against each occurrence.
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15. Select the specific highlighted occurrence, and you can position your click location relative to an
existing image.

Прим.:  If there are multiple images on an application screen that you are automating and when the
target image is not easily searchable; in that case, you can select an easily identifiable image in the
captured region and position your click relative to it.

16. If the target image is found multiple times in the captured region. In that case, you can select the
occurrence of a particular target image or select the occurrence number from the drop-down in the
Match number (optional) field on the right pane.
The Match number (optional) and the Target Offset fields on the right pane display the image
occurrence you selected and its offset coordinates of the target image.

17. Щелкните Отправить.
18. In the Target coordinate selections field, the coordinate options Center of match or Offset

from match will be selected automatically based on the action you performed in the Preview
window.
• Center of match: The image is selected based on the coordinates at the center of the matched

image.
• Offset from match: The image is selected based on the coordinates relative to that of the

matched image.

Прим.:  The offset coordinates measure the number of pixels from the top left corner of the image.

19. Select an option from the Action to take on target coordinates list to specify the action you want
to perform on the matched image in the application window.

20. Щелкните Сохранить.

Interactive forms пакет
The interactive forms пакет contains actions that handle exceptions encountered by a бот. All the actions
performed by users on the interactive forms can be monitored to execute logic using subtasks.
Interactive forms are first-class citizens within the бот repository and have the same workflows for moving
forms between public and private workspaces, and for export or import actions. Handling exceptions
ensures that a бот completes a task when it encounters an error.

Действия in the Interactive forms пакет

The interactive forms пакет includes form-level and element-level actions.
The following actions are available at the form level:

Действие Описание

Display Load and display the selected form.
Select or insert a variable in the Form name field to display the form when an
event is triggered. Optionally, select the check box to always display the form
window in front.

Закрыть Closes the selected form.
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Действие Описание

Show Loads or displays a hidden form.
Select or insert a variable in the Form name field for a hidden form, which is
displayed on the desktop when an event is triggered.

Hide Hides the selected form from the user's view.

Reset Resets the selected form to its default value.
Select or insert a variable in the Form name field for a form. All the values of
this specified form are reset when an event is triggered.

Validate form Validates all the elements within the selected form.
• Select or insert a variable in the Form name field for a specific form, which

is validated when an event is triggered.
• Select the next event by creating or selecting a variable using the Assign

the return value to a boolean variable field.

Прим.:  The Validate form action is not applicable to Rich Text Editor
elements.

Change Form
Title

Changes the title of the selected form.
• Select or insert a variable in the Form name field for a specific form.
• Enter the new title that must appear for the selected form in the New Title

(optional) field.

The following actions are available at the element level:

Действие Описание

Assign Assigns dynamic values to the Dropdown element of a form.
• Select or insert a variable in the Form name field.
• Select the Dropdown element of the form from the Form element field,

which is enabled when an event is triggered.
• Use Assign to set one of the following actions:

• Append: Specified values or variables are added to the selected
Dropdown element.

• Overwrite: Specified values or variables replace the existing data in the
selected Dropdown element.

Прим.:  The Assign action is now applicable for the Checkbox and Radio
Button elements in interactive forms.

Enable Enables the specified element of the selected form.
• Select or insert a variable in the Form name field.
• Select a specific element of the form from the Form element field, which is

enabled when an event is triggered.
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Действие Описание

Disable Disables the specified element of the selected form.

Get Retrieves the value from the specified element of the selected form.
• Select or insert a variable in the Form name field and use the Form

element to select a specific element of the form.
• Use the Returns the value drop-down menu to assign this value to a

variable when an event is triggered.

Create a variable

Set Assigns the user-defined or global variable to the selected element of the
specified form.
• Select or insert a variable in the Form name field and use the Form

element to select a specific element of the form.
If you select Table as the Form element, use the Set Value Type to
enable the following additional options:
• Таблица. Sets the variable value to the entire table.
• Row: Sets the variable value to the selected row.

• Use the Input value to assign a user-defined or system variable into this
element when an event is triggered.

Set focus Sets the focus on the selected element of a form.
• Select or insert a variable in the Form name field.
• Use the Form element to select the specific element of the form and set

the focus:
• For form elements such as a text box, text area, number or date, the

cursor appears on the element.
• For form elements such as a check box or radio button, the emphasis is

on the first option.

Highlight Highlights the specified element of the selected form.
• Select or insert a variable in the Form name field.
• Use the Form element to select the specific element of the form to

highlight it when an event is triggered.
• Use the Highlight Type drop-down menu to select one of the following:

• Warning: Displays a warning alert on the specified form element.
• Error: Displays an error alert on the specified form element.

Unhighlight Removes the highlight from the specified element of the selected form.
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Действие Описание

Change label Changes the label of the selected form element.
• Select or insert a variable in the Form name field.
• Use the Form element to select the specific element of the form for which

the label must change when an event is triggered.
• Enter the name in New label field.

Прим.:  The Change label action is now applicable for Button elements in
interactive forms.

Dynamic area

Add row in
Dynamic area

Applies only to forms that have a Dynamic element. This action renders the
selected form field as a single row when the бот starts.
• Select or insert a variable in the Form name field.
• Use the Dynamic area drop-down menu to select the dynamic element of

the form.
• Use Append or Overwrite to add a row for the specified dynamic area.
• Use Add element to insert elements into the dynamic area.

• Use the Type drop-down menu to select the element type such as
Checkbox group, Drop-down, File, Radio group, Snapshot, Text area, or
Textbox.

• Use the Label field to enter a name for the element.
• Click Add to add the element.

You can add up to four elements.

Clear Clears all the dynamic elements in the specified form.

IQ Bot Classifier пакет
IQ Bot Classifier пакет enables you to group or classify documents into appropriate learning instances for
content extraction in Automation 360 IQ Bot.

Прим.:  IQ Bot Classifier пакет is available on demand. Contact your Customer Success Manager (CSM) or
Partner Enablement Manager (PEM) for the пакет. You have to upload this пакет to Control Room.
Add пакеты to the Control Room

To use your existing боты, you must also add the license when prompted. This пакет has the following
requirements:
• User must be assigned the IQ Bot Classifier license.
• A Bot Runner user must be associated with role that has Administration > View License permission

enabled.
Create a role
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• Ensure that the Bot Agent version is not older than the previous two versions.
For example, if you upgrade to Automation 360 v.23 Сборка 11513 (On-Premises), ensure that the Bot
Agent version is not older than 21.82.10342.
См. раздел Совместимость Bot Agent.

.
The IQ Bot Classifier пакет enables you to segregate different types of documents into respective
categories. This output can then be used to build logic to merge pages in a document for enhanced data
extraction.
См. раздел How to merge documents in IQ Bot Classifier package (A-People login required).

Действия в IQ Bot Classifier пакет

The package contains the Classify, Classify documents, and Train Classifier actions. You can use
these actions to create a model file, and use the file to classify uploaded documents into different folders.
These actions work as a precursor to document processing.

Действия Описание

Классифицировать IQ Bot Classify action groups the pages of an input
document based on the model file that was created
using IQ Bot Train Classifier action.
См. Using Classify action

Classify documents The IQ Bot Classify document action groups the input
documents based on the first page of each document,
using the selected model file that is created with the IQ
Bot Train Classifier action. Use this action if you are
manually creating document groups.
См. Using the Classify document action

Train Classifier См. Using Train Classifier action

Watch the following video to understand how to use the IQ Bot Classifier пакет:
To learn more, review the courses in IQ Bot Developer learning trail: IQ Bot Developer Training (A-People
login required).
Понятия, связанные с данным
О классификаторе
Узнайте о том, как классифицируются документы, и о факторах, влияющих на классификацию.

Using Classify action
IQ Bot Classify action groups the pages of an input document based on the model file that was created
using IQ Bot Train Classifier action.
• If you have not done so already, use the Train Classifier action to create a model file. См. раздел

Using Train Classifier action.
• Ensure the input files are in PDF format. If the input file is an image file (.gif, .jpg, .png, or

.tiff), convert the image to a PDF. См. раздел Using ConvertImageToPDF action.
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Build a бот with the Classify action within a Loop action to iteratively classify each file in the selected
folder.
1. In the Действия palette, double-click or drag the Loop action from the Loop пакет.
2. In the Loop Type field, select the Iterator option.
3. In the Iterator field, select For each file in folder from the drop-down list.
4. In the Folder path field, select the path to the folder that contains the input files.
5. In the Assign file name and extension to this variable field, create or select a dictionary variable

to store the names and extensions of the files in the selected folder path.
For this example, we will use a dictionary variable named dictFile.

6. In the Действия palette, double-click or drag the Classify action from the IQ Bot Classifier пакет.
7. In the Input file field, enter a dynamic file path using a variable.

a) Add a file path pointing to the folder, for example C:\input\.
b) Add the dynamic file name string: $dictFile(name)$.$dictFile(extension)$.

Прим.:  Be sure to include a period between the variable holding the file name and the one
holding the extension.

The name and extension keys are predefined. When inserted and run in a loop, the action iterates
through the entire folder and calls the files in the folder one at a time. The Input file value looks like
this: C:\input\$dictFile(name)$.$dictFile(extension)$

8. In the Classifier field, provide the file path to the model file.
You can either select the .zip folder or extract the .icmf file from this folder and select it.

Прим.:  For better classification results and performance, we recommend that you use the .icmf file
available in the .zip folder obtained from the Train Classifier action.

9. Use the Output folder path option to save the classification output document.
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10. Необязательно: Configure the following ADVANCED SETTINGS:
• Confidence threshold (%): If the confidence value of the category prediction of a page is less

than the confidence threshold, it is moved to the Unclassified folder.
• Save classification output variable: Save the classification results as a list of dictionaries with

the following keys:
• fileName
• pageIndex
• категория
• confidence

Прим.:
• You can select the type of classification in the IQ Bot Classifier:

• Image-based classification
• Text-based classification
• Both image and text-based classification

• To project a higher confidence threshold, we suggest that you calculate the confidence threshold
when the document pages are similar. To determine the required confidence threshold, you can
review the confidence values from the classification output.

• The IQ Bot Classifier can auto-detect the language for classification, and supports all languages
supported by ABBYY (an optical character recognition application).

11. Click Save and Run.
The pages from the output document are saved in the respective subfolders, based on the categories
created in the model file. Any previously-classified documents in the output folder will be overwritten.

You can use each subfolder of similar documents to create and train a learning instance to extract data
from the documents. См. раздел Создать экземпляр для обучения.

Using the Classify document action
The IQ Bot Classify document action groups the input documents based on the first page of each
document, using the selected model file that is created with the IQ Bot Train Classifier action. Use this
action if you are manually creating document groups.
• Build and run a бот with the Train Classifier action to create a model file. См. раздел Using Train

Classifier action.
• Create a new document group

1. In the Действия palette, double-click or drag the Classify document action from the IQ Bot
Classifier пакет.

2. In the Input file field, provide the default filepath for incoming files for classification.
3. In the Classifier field, provide the filepath of the model file.

You can either select the .zip folder or extract the .icmf file from this folder and select it.

Прим.:  For better classification results and performance, we recommend that you use the .icmf file
available in the .zip folder obtained from the Train Classifier action.
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4. Use the Output folder path option to save the classification output documents.
The pages from the output document are saved in the respective subfolders based on the categories
created in the model file.

5. Необязательно: Configure the Confidence threshold (%).
If the confidence value of the category prediction of a document is less than the confidence threshold,
the document is moved to the Unclassified folder.

6. Select from Normal mode or Express mode.
• Normal mode: The Classifier parses the entire document and groups it based on the fields in all

the pages.
• Express mode: The Classifier groups the document based on the fields in the first page.

7. Выберите или создайте переменную списка для сохранения выходного значения.
The classification results as a list with the following keys:
• fileName
• pageIndex
• категория
• confidence

Using Train Classifier action
Use the Train Classifier action to create a model file that is used by the Classify action to sort the
documents into required categories for input.
Before building the бот, collect example documents and categorize them into folders. Ensure the set of
example documents meets the following requirements:
• Has at least two categories.
• A minimum of 15 pages per category (20 pages recommended).
• Split input PDF documents that have multiple pages into single-page PDF documents. См. раздел Using

the Split document action.
For example, if you have a PDF document that has three pages, split it into three single-page PDF
documents.

If these minimum requirements are not met, an error message is displayed during бот runtime.
Each folder has a selection of documents that are a sample of the documents that the associated learning
instance will process. The Train Classifier action will read through the files in the folders, and build a
model based on the documents stored inside each folder.

Прим.:  As ABBYY FineReader Engine Распознавание текста (OCR) is now downgraded to version 12.2
from version 12.4, older .icmf files cannot be used to retrain models in Automation 360 v.24 of the IQ
Bot Classifier пакет. If you want to add more categories or more files into your existing categories, you
must create a new model.

1. In the Действия palette, double-click or drag the Train Classifier action from the IQ Bot
Classifier пакет.

2. Click Train to continue creating a new model file.
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3. Необязательно: If you have an existing model file, click Re-Train.
a) Use the Training folder path field to select an existing folder path from the Desktop folder

tab.
Alternatively, click the Variable tab to manually enter an existing training folder path.

b) Use the Existing zip path field to select the filepath of the .zip folder from Control Room file
or Desktop file tab.
Alternatively, click the Variable tab to manually enter the path for the .zip folder.

Прим.:  When you train documents, a .zip folder is created, which contains .icmf, .data and
.properties files. Ensure you upload the entire .zip folder for retraining an existing model
file.

4. Select the input folder path from Desktop folder or Variable.
The input folder path must have subdirectories with the names that correspond to the category of the
documents that you want to train the classifier on. For example, if you have sales-related documents,
the input folder path must have subfolders such as Invoice and Purchase Order.

5. Необязательно: If you select Desktop file, click Browse to change the default filepath.
6. Enter a name for the model file in the Model name field.
7. Use the Model output path field to select the directory for the output model file.
8. Необязательно: Configure the following ADVANCED SETTINGS:

a) Training Optimization: Use the drop-down menu to select the type of training optimization.
• Precision: select this option when you want your training model to be precise but can miss

out on few documents.
• Recall: select this option when you want the training model to find all the relevant cases

within a dataset.
• F1 score: is selected by default and the recommended setting as it combines the training

optimization of both Precision and Recall.

F1 score is the selected by default. Precision and Recall.
b) Classification Type: Use the drop-down menu to select the features you want to include such

as text, image, or both.
Text and image is selected by default. If you select Text or Text and image, list of supported
languages is displayed in the Recognition Language drop-down menu.

c) OCR Settings: The Extract all text blocks and Extract text from images are enabled by
default.
With the OCR Settings enabled by default, more time is consumed by Распознавание текста
(OCR) in extracting the content. This ensures that relatively lower quality documents are also
handled based on the inputs from Распознавание текста (OCR).

9. Click Save and Run.
The model is created as a .icmf file in the directory specified in the Model output path field.

After creating the model, build a бот to classify input documents. См. Using Classify action

IQ Bot [Local Device] пакет
Avoid having to manage a separate IQ Bot cluster setup by leveraging your existing pool of RPA devices
and process documents using multiple Bot Runner.
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Прим.:  This пакет is deprecated from Automation 360 v.22 (Сборка 10526). IQ Bot Extraction пакет
provides all the capabilities provided by the IQ Bot [Local Device] пакет along with some improvements.
IQ Bot Extraction пакет has Process Documents action that is similar to IQ Bot [Local Device] пакет. So
before using the IQ Bot Extraction пакет, ensure that you update the боты associated with the Process
Documents action of the IQ Bot [Local Device] пакет by performing the following steps:
1. Open the бот.
2. Copy or save the configured settings for the Process Documents action.
3. From the IQ Bot Extraction пакет, drag the Process documents action into the workflow.
4. Apply the settings you copied or saved from the Process Documents action of the IQ Bot [Local

Device] пакет.
5. Delete the Process Documents action of the IQ Bot [Local Device] пакет from the workflow.
6. Сохраните бот.

Additionally, ensure that you update the output folders according to the following folder structure:
• Успешные. Contains the processed CSV files.
• Проверить. Contains the documents as CSV files that have failed the validation rules.
• Повторное обучение. Contains documents that must be retrained because of one of the following

conditions:
• If a бот is not available, the original document is copied in the folder.
• If the validation fails, the original document is copied in the folder.

• Необработанные. Contains documents that encountered errors during processing.

Перед началом работы

IQ Bot [Local Device] пакет helps you scale by processing documents on multiple devices simultaneously
using a device pool. You can set this up using workload management in the Control Room.

Управление рабочей нагрузкой
• If you are using a device pool, then you have to set up a shared file system so that all the Bot Runner

can process and store documents at the same location.
• This command performs parallel processing at the folder level, so you have to set up input files in

separate folders.
• You must have the IQ Bot Services role along with the Bot Runner role to run боты in production. This

is required so that the Bot Runner can access the IQ Bot server when using a device pool.
• The пакет does not create new groups and the documents that do not match the existing groups are

sent to IQ Bot Валидатор on the IQ Bot server.

Действия в IQ Bot [Local Device] пакет

The пакет includes the following action:

Действие Описание

Process Documents См. Using Process Documents action
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Понятия, связанные с данным
IQ Bot Extraction пакет
Capability to automatically extract values provides enhanced content extraction from invoices.
Задачи, связанные с данной
Использование action IQ Bot Обработка документов
Используйте это action для извлечения значений из счетов-фактур с помощью предварительно
обученной модели.

Using Process Documents action
Use the action to process documents using TaskBots created in the Control Room.
1. In the Действия palette, double-click or drag the Process Documents action from the IQ Bot

[Local Device] пакет.
2. In the right-side pane, select the learning instance from the drop-down list.

You can click the refresh option to view the updated list.
Only the ABBYY FineReader Engine and Tesseract4 OCR engines are currently supported.

3. Enter the Input documents folder path.
• Enter the folder path as text or choose a folder using the Browse option.
• Either enter a variable name or click Variable to select a variable from the list.

4. Enter the Output folder path path.
• Enter the folder path as text or choose a folder using the Browse option.
• Either enter a variable name or click Variable to select one from the list.

5. Select the Validator settings check box if you want to review documents in the IQ Bot Валидатор.
When you enable this setting, documents are stored in the IQ Bot server's output path. To download
documents back to your local device, use the Download all documents action in the IQ Bot пакет.
Download all documents action

The following types of documents are sent to the IQ Bot Валидатор:
• Failed documents (exceptions)
• Unclassified documents
• Documents that do not belong to any group

Прим.:  If you do not want to use the IQ Bot Валидатор, do not enable this setting. You can build
your own Валидатор using Interactive forms and the dashboards on Bot Insight.
Using interactive forms

6. Щелкните Сохранить.

IQ Bot Pre-processor пакет
Use the IQ Bot Pre-processor пакет to extract content from documents or process image files before they
are sent to Automation 360 IQ Bot.

Прим.:  This пакет is not available as part of the standard Automation 360 IQ Bot installation. To
download and install this пакет, perform these steps:
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1. Download the пакет from the Automation Anywhere support site:
A-People Downloads page (Login required)

The пакет is a .jar file available in the IQ Bot installation folder.
2. Upload the пакет to Control Room.

Add пакеты to the Control Room

Прим.:  Ensure that the Bot Agent version is not older than the previous two versions.
For example, if you upgrade to Automation 360 v.23 Сборка 11513 (On-Premises), ensure that the Bot
Agent version is not older than 21.82.10342.
См. раздел Совместимость Bot Agent.

After installation, administrator can locate the пакет in Automation 360: Manage > Packages.
Windows Media Foundation platform must be installed on your Bot Runner machine in order to use the
following actions without any errors.

Действия в IQ Bot Pre-processor пакет

The following table lists the actions used for processing image file:

Действия Описание

ConcatenateImages См. Using ConcatenateImages action

ConvertImageToPDF См. Using ConvertImageToPDF action

EditImage См. Using EditImage action

EnhanceImage См. Using EnhanceImage action

OrientImage См. Using OrientImage action

The following table lists the actions used for extracting content from documents:

Действия

GetBarCodes См. Using GetBarCodes action

GetDocumentInfo См. Using GetDocumentInfo action

GetPageContent См. Using Get page content action

To learn more, review the courses in IQ Bot Developer learning trail: IQ Bot Developer Training (A-People
login required).

Using ConcatenateImages action
Use the ConcatenateImages action in the IQ Bot Pre-processor пакет to link two image files.
1. Drag the IQ Bot pre-processor > ConcatenateImages action into your workflow.
2. Use the Input file path 1 field to select the first input file from Control Room file, Desktop file or

Variable.
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3. Необязательно: If you selected Control Room file or Desktop file, click Browse to change the
default filepath.

4. Use the Input file path 2 field to select the second input file.
5. Select the output folder from the Output Path field.
6. Необязательно: Click Browse to change the default output filepath.
7. Use the Concatenate Type field to select one of the following options:

• Vertical: To vertically concatenate or link the selected images.
• Horizontal: To horizontally concatenate or link the selected images.

8. Необязательно: Use the Assign output status to variable field to set the output status of action
during бот runtime.

9. Щелкните Сохранить.
When the бот runs successfully, the combined image file is saved in the specified output folder.

Using ConvertImageToPDF action
Use the ConvertImageToPDF action in the IQ Bot Pre-processor пакет to convert a selected image
file to a text-enabled PDF document. The converted PDF file retains the name of the input image file by
default.
1. Drag the IQ Bot pre-processor > ConvertImageToPDF action into your workflow.
2. Select the input file from Control Room file, Desktop file or Variable.
3. Необязательно: If you selected Control Room file or Desktop file, click Browse to change the

default filepath.
4. Use the Output Path field to select the output folder for the PDF document.
5. Необязательно: Click Browse to change the default output filepath.
6. Необязательно: Choose from the following advance settings:

• Input file settings: Use this field to select various input file settings.
For example, if the input file is a legal document (a bank check), select the Has MICR check box.

• Process settings: Use this field for processing the output file.
For example, select the Process text blocks independently check box if the OCR engine must
process various blocks of the input file as a specific text type.

7. Необязательно: Use the Save the output status of the action as boolean to set the output
status.

8. Щелкните Сохранить.
When the бот runs successfully, the processed PDF file is saved in the specified output folder.

Using EditImage action
Use the EditImage action in the IQ Bot Pre-processor пакет to resize an image file.
1. Drag the IQ Bot pre-processor > EditImage action into your workflow.
2. Select the input file from Control Room file, Desktop file or Variable.
3. Необязательно: If you selected Control Room file or Desktop file, click Browse to change the

default filepath.
4. Use the Output Path field to select the output folder.
5. Необязательно: Click Browse to change the default output filepath.
6. Use the Select Image Edits drop-down menu to select one of the following options:

• Crop: Use an auto-crop or manual option to crop the image.
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• Resize: Change the height and width of the image.

7. Необязательно: Use the Assign output status to variable field to set the output status of action
during бот runtime.

8. Щелкните Сохранить.
When the бот runs successfully, the edited image file is saved in the specified output folder and is
suffixed by the word processed.
For example, if the image filename is Sales.png, the processed file is saved as
Sales_processed.png

Using GetBarCodes action
Use the GetBarCodes action in the IQ Bot Pre-processor пакет to detect and extract all available
barcodes from a document.
1. Drag the IQ Bot pre-processor > GetBarCodes action into your workflow.
2. Select the input file from Control Room file, Desktop file or Variable.
3. Необязательно: If you selected Control Room file or Desktop file, click Browse to change the

default filepath.
4. Use the List of dictionaries with 7 keys drop-down menu to select the output format for the

extracted strings.
If the document has multiple barcodes, multiple dictionaries are used as each dictionary corresponds
to a single barcode. Each dictionary has the following seven keys that relate to the various attributes
of the barcode in a document:
• Page number of the document where a barcode is available
• Type of the barcode
• Value of the barcode
• X coordinate of the barcode
• Y coordinate of the barcode.
• Width of the barcode
• Height of the barcode

5. Щелкните Сохранить.
When the бот runs successfully, the extracted barcodes are assigned to the output variable.

Using GetDocumentInfo action
Use the GetDocumentInfo action in the IQ Bot Pre-processor пакет to extract document information
such as the page count and extension type.
1. Drag the IQ Bot pre-processor > GetDocumentInfo action into your workflow.
2. Select the input file from Control Room file, Desktop file or Variable.
3. Необязательно: If you selected Control Room file or Desktop file, click Browse to change the

default filepath.
4. Use the Dictionary object with 5 keys drop-down menu to select the output format for the

extracted information.
Each dictionary has the following five keys that relate to the various attributes of the document:
• Filepath of the document location
• Extension type of the document
• File type of the document
• Total number of pages in the document
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• File size of the document

5. Щелкните Сохранить.
When the бот runs successfully, all the extracted information for the selected document is assigned to
the output variable.

Using Get page content action
Use the Get page content action in the IQ Bot Pre-processor пакет to extract text from a specific page
of a document (PDF, image file) into a list of strings.
1. Drag the IQ Bot pre-processor > Get page content action into your workflow.
2. Select the input file from Control Room file, Desktop file or Variable.
3. Необязательно: If you selected Control Room file or Desktop file, click Browse to change the

default filepath.
4. Enter the page number of the selected document from which the content must be extracted.
5. Use the List of strings extracted from page drop-down menu to select the output format for the

extracted strings.
You can use this menu to create a variable with Type > List and Subtype > String. Alternatively,
you can select an existing variable with Type > List, and Subtype > String or Subtype > Any.

6. Щелкните Сохранить.
When the бот runs successfully, the content extracted from the specific page of the selected
document assigned to the output variable.

Using EnhanceImage action
Use the EnhanceImage action in the IQ Bot Pre-processor пакет to enhance a selected image file.
1. Drag the IQ Bot pre-processor > EnhanceImage action into your workflow.
2. Select the input file from Control Room file, Desktop file or Variable.
3. Необязательно: If you selected Control Room file or Desktop file, click Browse to change the

default filepath.
4. Use the Output Path field to select the output folder.
5. Необязательно: Click Browse to change the default filepath.
6. Необязательно: Click Add effect and use Effect type drop-down menu for image enhancement

options.
For more information on the available options, see Image enhancement options in EnhanceImage action.
Consider a scenario where you have uploaded a low quality image. Use the following options to
improve the clarity and increase the brightness:
• Select Effect type > SHARPEN.

Additional fields associated with sharpening an image such as Gaussian blur, Alpha, Beta and Gama
are displayed.

• For this example, enter 5 in the Alpha field.
Value between 0 to 10 can be used in the additional fields. Optionally, you can also press F2 or
click Insert a value option to select a system value.

• Select Effect type > BRIGHTNESS.
• Enter 7 in the Brightness factor field.

The selected enhancement options are listed in the Effect type field, and you can edit or delete a
specific effect type.

7. Click Add.
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8. Необязательно: Use the Assign output status to variable field to set the output status of action
during бот runtime.

9. Щелкните Сохранить.
When the бот runs successfully, the enhanced image file is saved in the specified output folder.

Image enhancement options in EnhanceImage action
Improve the quality of an image that you have uploaded in the EnhanceImage action by using additional
options available.

Вариант Использовать

Grayscale Convert the color pixels in an image to grayscale.
Recommended: Convert color images to grayscale to improve the
Распознавание текста (OCR) extraction accuracy.

Blur Smoothen out areas that are pixelated and improve image quality.
Recommended values: Any odd number (such as 3, 7, and 11), as long
as it is less than the pixel size of the uploaded image.

Sharpen Improve clarity by removing distorted and blurred aspects of the original
image.
Consider a scenario where you have an image file called ImageA. When
you apply Gaussian blur = 5 to this image, a blurred version of this
image is created called ImageB. You can then use the following Sharpen
parameters:
• Alpha: 3
• Beta: -1
• Gamma: 0

The following formula is applied for output:
Output = ImageA*Alpha + ImageB*Beta + Gamma
Where:
• ImageA: First input array (Input image)
• Alpha: Weight of the first array elements
• ImageB: Second input array image with the same size and channel

number as ImageA
• Beta: Weight of the second array elements
• Gamma: Scalar added to each sum

Прим.:  The principal use of the preceding equation is to sharpen an
image by removing the blurriness from the original image.

Recommended values:
• Gaussian blur: 0 to 10
• Alpha: 1 to 15
• Beta: -0.5 to -5
• Gamma: 0 to 50
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Вариант Использовать

Denoise Smoothen out pixels that are not grayscale to remove distortion or
speckling from the image.
Recommended value: 21. However, it can be any odd number as long
as it is less than the pixel size of the uploaded image.

Contrast Increase or decrease the contrast of the pixels. Values can range from 0
(no change) to 2 (maximum contrast).
Recommended values: From 0.8 through 2.

Brightness Increase or decrease the brightness level of all the pixels in the image.
Values can range from -100 (minimum contrast) to 100 (maximum
contrast), with 0 representing no change.
Recommended values: From 0 through 100

Thresholding A form of image segmentation. Thresholding is an image processing
method that creates a bi-tonal (binary) image by setting a threshold
value on the pixel intensity of the original image. In image processing,
thresholding is typically used to separate objects or foreground pixels
from background. For example, the following image has been processed
using Thresholding value as 200 and 100 respectively.

Recommended value: From 0 through 255

Remove RGB Provide upper and lower bound values to pixels in a color image. Pixels
in a color image are represented by three primary color channels: red,
green, and blue (RGB). The output of this effect is a binary image with
pixels that are black (0) or white (255). Consider a scenario where you
want to transform high-intensity red pixels in the range of 200 to 255 to
white (255). You can set the lower bound for red to (200,0,0) and upper
bound to (255,0,0).

Using OrientImage action
Use the OrientImage action in the IQ Bot Pre-processor пакет to change the orientation of a selected
image file.
1. Drag the IQ Bot pre-processor > OrientImage action into your workflow.
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2. Select the input file from Control Room file, Desktop file or Variable.
3. For the Control Room file and Desktop file tabs, click Browse to change the default filepath.
4. Use the Apply settings field to change the following orientation options:

• Flip: Use the drop-down menu to flip the image horizontally, vertically, or horizontally and
vertically.

• Rotate: Use the drop-down menu to:
• Rotate the image clockwise or anti-clockwise.
• Change the angle of the image.

For example, enter 45 if you want to change the image angle by 45 degrees.

5. Щелкните Сохранить.
When the бот runs successfully, the modified image file is saved in the specified output folder.

IQ Bot Extraction пакет
Capability to automatically extract values provides enhanced content extraction from invoices.
Learning instance is an IQ Bot environment that enables you to train sample documents for content
extraction. By constantly refining the learning instance, you can achieve a high content extraction accuracy
before deploying the learning instance across a production environment.
IQ Bot Extraction пакет combines learning instance (new or existing) and a pretrained machine learning
model to automatically extract content. The pretrained machine learning model uses data points to extract
content from the supported document types. By providing additional training to an existing learning
instance, you can extract content from other document types as well.

Прим.:  This пакет is deprecated from Automation 360 v.26. IQ Bot Document Automation provides all
the capabilities provided by the IQ Bot Extractionпакет. To move your bots from the IQ Bot Extraction
пакет to Document Automation, see Move from IQ Bot Extraction пакет to Document Automation.

The following diagram shows the IQ Bot Extraction пакет workflow:
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Contact your Customer Success Manager (CSM) or Partner Enablement Manager (PEM) for more
information on the high level architecture, design and folder structure.
High level architecture, design overview, folder structure of IQ Bot Extraction package (A-People login required)

IQ Bot Extraction пакет provides the following extraction methods:
Content extraction with minimum training
The IQ Bot Extraction пакет is designed to extract values with minimum training from specific document
type such as an invoice or purchase order.

Прим.:  For this content extraction method, ensure you always use the ABBYY FineReader Engine
Распознавание текста (OCR) 12.4 engine.

Consider a scenario where you want extract sales data from various invoices. Create a learning instance
by selecting a pretrained domain or document type used to extract data. In this scenario, you can select
the document type as invoice, which provides a set of preset fields for content extraction. Ensure you
upload a sample invoice document as a reference. Additional training of the learning instance group is not
required. Use the IQ Bot Extraction пакет to link this learning instance to a бот. You can then run this бот
to retrieve sales data based on the preset fields for various invoices.
Enhanced extraction with additional training
The IQ Bot Extraction пакет uses a combination of backend engine with IQ Bot server for enhanced
document extraction. You can use an existing learning instance to provide additional training for all the
available document groups. By customizing the various fields and validation settings of the learning
instance group, you can use this пакет content extraction across other document types.

Важное замечание:  This пакет is not available as part of the standard Automation 360 IQ Bot
installation. To download and install this пакет, perform these steps:
1. Download the пакет from the Automation Anywhere support site. The пакет is a .jar file available in

the IQ Bot Installation Setup folder.
A-People Downloads page (Login required)

2. Upload the пакет to Control Room.
Add пакеты to the Control Room

Перед началом работы

• Ensure you create a learning instance using a supported OCR.
• Select documents with common layouts.

The preset model contains logical group. It is important to select an existing group for default validation
rules to avoid documents with errors in the Success folder.

• Ensure that the Bot Agent version is not older than the previous two versions.
For example, if you upgrade to Automation 360 v.23 Сборка 11513 (On-Premises), ensure that the Bot
Agent version is not older than 21.82.10342.
См. раздел Совместимость Bot Agent.
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Действие в IQ Bot Extraction пакет

The following action is available to build a бот for extracting data:

Действие Описание

IQ Bot Extraction См. раздел Использование action IQ Bot Обработка
документов.

Watch the following video to understand how to use the IQ Bot Extraction пакет:
Задачи, связанные с данной
Select an Распознавание текста (OCR) engine
You can select an Распознавание текста (OCR) engines that suits your requirement for data extraction
based on your document types. Restarting IQ Bot services is not necessary for implementing an engine
change.

Move from IQ Bot Extraction пакет to Document Automation
As of the Automation 360 v.26 release, the IQ Bot Extraction пакет will be deprecated. Instead, configure
your learning instances from Automation 360 IQ Bot to extract data in the new document processing
solution, Document Automation.
Check if any боты in use the IQ Bot Extraction пакет: Navigate to Manage > Packages, and
search for the IQ Bot Extraction пакет. If the status is Enabled, you must do steps on this page to
identify the боты that contain the Process documents action and the associated learning instances, and
configure those learning instances to run in Document Automation.

Set up your Set up your Document Automation environment, which includes creating a custom role and users
to perform tasks in Document Automation.
In this page, you connect your learning instances from Automation 360 IQ Bot, build a бот to upload
documents to Document Automation, publish the learning instance assets, and deploy them to a Bot
Runner.
1. Identify the learning instances that you must connect to Document Automation:

a) Navigate to Automation page, under the Public tab, locate the Bots folder.
b) Click on a TaskBot to open the Bot editor.
c) If the TaskBot contains the IQ Bot Extraction > Process documents action, locate the

Learning instance name field and note the value. This is the name of the learning instance that
you must connect to Document Automation.

d) Repeat these steps to identify all the learning instances that must be connected to Document
Automation.

Connect your learning instances to Document Automation
Когда вы подключаете обучаемый экземпляр, который создан в Automation 360 IQ Bot, система
создает активы обучаемого экземпляра (боты RPA, процесс AARI и форма), чтобы обучаемый
экземпляр мог начать обработку документов в Document Automation.
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Прим.:
• This feature is available only for Document Automation customers. It is not available in Community

Edition.
• Окружение Automation 360 IQ Bot должно быть связано с Control Room, где выполнена установка

Document Automation. Кроме того, следует использовать версию Automation 360 IQ Bot,
совместимую с Control Room.

• Можно подключить один обучаемый экземпляр за раз.

2. Login to the Control Room as the Admin user. Navigate to Manage > Learning Instances. Click
Connect learning instance.
This takes you to Connect Learning Instances from IQ Bot classic page which contains a list of
Automation 360 IQ Bot learning instances.

3. Выберите обучаемый экземпляр из версии Automation 360 IQ Bot
для подключения. Move it from left to right. Щелкните Подключить.

The newly-connected learning instance appears in the Learning instances table in private mode.
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4. Upload documents to the learning instance that you connected in the previous step to test its
extraction capability.
a) Щелкните Обработка документов.

b) В окне Документы процесса щелкните Обзор, чтобы выбрать файлы для загрузки.
c) In the Download data to field, enter the file path that will hold extracted data.

When the process runs, it creates the following three folders in the provided file path:
• Success: Contains the extracted data in the specified format (CSV or JSON).
• Invalid: Holds documents marked invalid.
• Failed: Holds documents that could not be processed.

You can provide an output folder path based on one of the following options:
• Вариант 1. The local device path if you have set up document processing and validation on

the same device.
This option is typically used when you are testing the learning instance.

• Вариант 2. The shared folder path if you have set up distributed validation on separate
devices.
This option is typically used for published learning instances. For example, \
\10.239.192.60\Sharepath\Output.

d) Щелкните Обработка документов.
The Bot Runner window appears. The window disappears when the documents are done
processing. Refresh the Learning instances table to see the updated metrics.

If there is a value next to the Validate documents link, you must manually validate the document fields.
Otherwise, proceed to step 3.
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5. Fix the validation errors
a) Click Validate documents.

The AARI Task Manager opens in a new tab, with the first failed document in queue. For an
introduction to the Validator user interface, see Using the AARI Task Manager Validator for Document
Automation.

b) Review each field to verify the data type and extracted value.
Document Automation supports the following data types: text, number, time, and check box
Alternatively, from the drop-down list on the right panel, you can select Show fields that need
validation.

Прим.:  When documents are awaiting validation, if you edit the learning instance, click
Reprocess to reattempt extraction.
Reprocessing documents does not affect the uploaded documents metric.

c) Update the fields with errors.
Click the field or draw a box around the values that you want to extract.
For Automation Anywhere pre-trained models, you can configure the learning instance to extract
specific values in a field and ignore others. Подробнее см. в разделе Using validation feedback to
extract specific values in a table.

• To skip a document without correcting errors, click Skip to proceed to the next document in
the validation queue.

• To remove a document that cannot be processed, click Mark as Invalid.

d) After you make the necessary corrections, click Submit so that the document can finish
processing.
The next document in queue appears. When all the documents are corrected, the system displays
a message stating that no more tasks are available.

e) Close the tab to return to the Learning Instances page.

6. Verify the output results:
a) Open the file in the Success folder that contains the extracted data and review the results to

ensure that it matches your use case.
b) Необязательно: Review the Learning Instance dashboard.

The dashboard displays the total number of uploaded documents and the number of documents
pending validation.

Configure the learning instance to process documents in production
7. Build the Extraction-Scheduler бот to automate uploading documents to the learning instance:

Build a бот to upload documents to Document Automation
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8. Publish the process.
a) Navigate to Automation > Private tab > Bots > Document Workspace processes and

select the folder with the same name as the learning instance.
b) Mouse over the vertical ellipses to the right of the process to open the actions menu and click

Check in process.
The Check in Process window opens with the боты and form auto-selected to also be checked
in.

c) In the Check in Process window, add your comment and click Check in.
The process appears in the same folder structure in the public workspace.

See these steps in a video:

9. Publish the Extraction-Scheduler бот.
a) Locate the Extraction-Scheduler бот in the private tab.
b) Mouse over the triple ellipses to the right of the бот to open the menu and click Check in Task

bot.
The Check in Task bot page opens with the бот auto-selected.

c) Add a comment and click Check in.

10. Login as the Document Automation Admin user to deploy the process and боты to unattended
Bot Runner devices: Deploy the learning instance assets

Build a бот to upload documents to a specific learning instance for processing and extraction: Build a бот to
upload documents to Document Automation

Использование action IQ Bot Обработка документов
Используйте это action для извлечения значений из счетов-фактур с помощью предварительно
обученной модели.
1. Перетащите action Обработка документов в поток операций.
2. В раскрывающемся меню Имя обучаемого экземпляра выберите существующий обучаемый

экземпляр.
3. Выберите одну из следующих вкладок для входных документов:

• Папка рабочего стола. Введите путь к папке или щелкните кнопку Обзор, чтобы выбрать
папку.

• Переменная. Введите имя переменной или просмотрите список и выберите переменную.

4. Выберите папку (а не один документ), в которой находятся все документы, которые необходимо
обработать.

5. Выберите выходную папку в поле Путь к выходной папке.
6. Необязательно: Установите флажок Отправить документы в валидатор IQ Bot на

проверку.
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Хотя документы обрабатываются с помощью Bot Runner на вашей локальной машине, вы
должны использовать этот параметр, если хотите проверить документы в Валидатор IQ Bot.

7. Необязательно: В поле Метка группы укажите строковую переменную, содержащую имя
папки, в которой находятся отсортированные документы.
Это необходимо для определения группы документов, созданной пользователем. Подробнее см.
в разделе Create a new document group.

8. Щелкните Сохранить.

После запуска TaskBot выходная папка может содержать до четырех подпапок:
• Успешные. Содержит документы, из которых пакет успешно извлек все поля, отображаются как

файлы .csv.
• Проверить. Содержит документы, требующие проверки.

Документы отображаются в формате файлов .csv и IQ Bot извлекает данные до их проверки.
Однако, если вы выберете этот параметр, эти документы будут доступны в Валидатор и вы
сможете загрузить валидированные выходные данные отдельно.

• Повторное обучение. Содержит документы, которые были отправлены на проверку.
Эти документы хранятся в исходном формате, и вы можете обучить их, загрузив в существующий
обучаемый экземпляр. пакет не создает новые группы. Чтобы создать новые группы и обучить
неудачные документы, используйте параметр Загрузить для отправки документов из папки
Выходные данные\Повторное обучение в ваш обучаемый экземпляр. Группы создаются на
основе параметра Порог создания групп, определенного в обучаемом экземпляре.

• Необработанные. Содержит документы, которые не были обработаны из-за ошибок во время
выполнения.
Эти документы хранятся в исходном формате, и вы можете обработать их с помощью пакет IQ
Bot Extraction.

Если вы используете Валидатор IQ Bot, проверенные файлы сохраняются в папке выходных данных
сервера IQ Bot. Use the IQ Bot > Download all documentsIQ Bot: Загрузить все документы для
загрузки файлов в папку выходных данных на локальном устройстве.

IQ Bot пакет
The IQ Bot пакет enables you to upload and download documents from an IQ Bot server.

Действия в IQ Bot пакет

пакет IQ Bot включает в себя указанные ниже actions.

Действие Описание

Download all
documents

См. раздел Download all documents action.

Загрузить документ См. раздел Upload document action.

To perform these tasks using APIs, see APIs to upload files, check file status, and downloading CSV file (A-
People login required)
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Download all documents action
Используйте action Загрузить все документы для загрузки с сервера IQ Bot извлеченных
результатов, которые созданы в результате выполнения Бот при помощи action Загрузить
документ.

Прим.:  Чтобы выполнить эту задачу с помощью API, см. использование API для загрузки файлов,
проверки статуса файлов и загрузки CSV-файлов (требуется вход на сайте A-People).

IQ Bot извлекает поля из документов и экспортирует их как файлы CSV. Это action также позволяет
загружать любые неклассифицированные, неподготовленные и недействительные документы в ваш
локальный каталог.
Выполните следующие шаги, чтобы загрузить извлеченные результаты с сервера IQ Bot.
1. На палитре Действия дважды щелкните или перетащите action Загрузить все документы из

пакет IQ Bot.
2. В поле Имя обучаемого экземпляра выберите имя.
3. В поле Статус документа выберите подходящий статус для документов.

• Успешные. Документы обработаны и представлены в формате .csv.
• Недействительные. Документы отмечены как недействительные во время процесса

проверки.
• Неклассифицированные. Не удалось классифицировать документы по группам.
• Неподготовленные. Документы классифицированы по новым группам в процессе

обработки и требуют обучения.
• Сбой. Документы, которые не удалось обработать и которые требуют повторной обработки.

Документ отражает Статус документа как Не удалось, если при извлечении данных,
проверке или сохранении конечного результата в базе данных возникает исключение.

Необработанные документы в папках Недействительные, Неклассифицированные,
Неподготовленные и Сбой доступны в исходном формате. Например, если входные
документы были в формате .pdf, то выходные файлы в указанных выше папках будут также
представлены в формате .pdf.

Прим.:  После загрузки документа с помощью action Загрузить необходимо периодически
выполнять action Загрузить для получения последних результатов с сервера. Поддерживайте
интервал от 30 секунд до 1 минуты между выполнением двух последовательных и одинаковых
action Загрузить для IQ Bot.

4. In the Local output folder field, provide the path to the file that will hold the output.
5. Для флажка Удалить файлы с сервера после загрузки выберите вариант удаления

документов.
При выборе этого варианта сжатый файл .zip, содержащий неудачные документы, будет
доступен для повторной загрузки, даже если загрузка не удалась. Поэтому следует выбрать этот
параметр.

6. Необязательно: В поле Сохранить ответ в переменную добавьте переменную. Например,
выберите в раскрывающемся списке prompt-assignment - string.
Значение переменной в этом поле предоставляет информацию о том, была ли загрузка
успешной или неудачной, а также сведения о причине сбоя.

7. Щелкните Обновить.
8. Щелкните Сохранить.
9. Щелкните Запустить сейчас.
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10. Щелкните Закрыть.

Прим.:  Если загрузка не удалась, проверьте переменную, используя Окно сообщений или
action Записать в файл. См. описание поля Сохранить ответ в переменную.

11. Перейдите в локальную папку вывода, чтобы просмотреть загруженные файлы.

Upload document action
The Upload Document action enables you to upload a document with IQ Bot. IQ Bot extracts fields from
the document and exports them to CSV files.
• Gain access to an Control Room.
• Ensure your local host is a registered device in the Control Room.

Прим.:  To perform these tasks using APIs, see using APIs to upload files, check file status, and download CSV
files (A-People login required).

Use the Upload Document action to upload a single document to the Control Room.

Прим.:  Azure confidential computing enables organizations to upload encrypted data to secured storage,
such as private folders on a virtual machine. If you upload documents from such secured folders to IQ Bot,
these are moved to Unclassified status as data extraction is not supported for such documents.

Follow these steps to upload a document:
1. In the Действия palette, double-click or drag the Upload Document action from the IQ Bot пакет.

Прим.:  A file size of 50 MB is supported for the upload action.

Прим.:  The file names of the documents that you upload should not start with special characters,
such as the hyphen (-).

2. В поле Имя обучаемого экземпляра выберите имя.
3. In the File path field, specify the location or type of the file.
4. Необязательно: В поле Метка группы укажите строковую переменную, содержащую имя

папки, в которой находятся отсортированные документы.
Это необходимо для определения группы документов, созданной пользователем. .

5. Необязательно: In the Save the response to variable field, add a variable. For example: select
prompt-assignment - string from the drop-down list.
A variable value in this field provides information about the file upload process: if the upload was
successful or failed, and the reason for the failure.

6. Щелкните Применить.
7. Щелкните Сохранить.
8. Щелкните Запустить сейчас.
9. Щелкните Закрыть.

To upload multiple files, insert the Upload Document action into a Loop action. See the Цикл пакет.

JavaScript пакет
The JavaScript пакет contains actions to run a JavaScript from a бот. These actions can run JavaScript
on Windows, Linux, and UNIX based devices.
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Перед началом работы

1. Open a JavaScript file, or specify the script you want to run using the Open action. You must
associate the details of the file or script you want to run with a session name. Use this same session
name for other JavaScript actions.

2. Use the Run JavaScript action to run a function within a script or an entire script. You must use the
same JavaScript session name established in the Open action.

3. Close the JavaScript session after running the script.
To review the бот launcher logs, navigate to C:\ProgramData\AutomationAnywhere
\BotRunner\Logs\<current month>\Bot_Launcher-<today's date>.log.zip. Each
zipped folder contains a file with data on the code execution, which is useful for debugging.

Прим.:  Review the following known JavaScript exceptions (other exceptions might exist based on
individual scenarios):
• All JavaScript run with JavaScript actions on the terminal.
• We do not support any JavaScript that requires a browser to run.

Действия в JavaScript пакет

пакет JavaScript включает в себя указанные ниже actions.

Прим.:  If you built a бот using actions from the JavaScript пакет from Сборка 5322 or earlier, the
actions will be missing when you open the бот with the default пакет version. You must reinsert the
actions and repopulate the fields.

Действие Описание

Закрыть См. раздел Close action in JavaScript.

Открыть См. раздел Open action in JavaScript.

Run JavaScript См. раздел Run JavaScript action.

Close action in JavaScript
This action enables you to close the session.

Настройки

To close the JavaScript, specify the same session name from the Open action.

Open action in JavaScript
You can open a JavaScript file using this action.
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Настройки

Opens a JavaScript file.
• In the  JavaScript  session field, specify a session name. Use this same session name for other 

JavaScript  actions.
• Choose one of the following options:

• In the Import existing file option, select an existing JavaScript file.

Прим.:  If you are uploading a script from a file on your desktop, the file and any dependencies
must be in a standalone folder. When you select a file for upload, all files and folders at the same
folder level are uploaded.

• In the Manual input option, enter the JavaScript.

Run JavaScript action
This action enables you to run a function within the JavaScript file.

Настройки

Runs a function within the JavaScript.
• In the  JavaScript  session field, specify a session name. Use the same session name from the Open

action.
• Необязательно. Укажите имя функции для выполнения и аргументы, которые нужно передать

функции.

Прим.:  You can pass only a list variable as an argument for the function. You can use the list variable
to pass multiple arguments of different data types such as Boolean, datetime, number, and string.

• Необязательно. In the Assign the output to variable field, specify the variable. В  отображается
описательное имя переменной по умолчанию. If you create several output variables, subsequent
variable names are appended with a -1, -2, -3, and so on to avoid duplication.

пакет JSON
Извлеките необходимую информацию из текста или файла JSON с помощью пакет JSON и
используйте извлеченные значения в ваших боты.

Перед началом работы

Используйте actions из пакет JSON в указанном ниже порядке.
1. Запустите сеанс JSON с помощью action Начать сеанс. Используйте это имя сеанса для всех

соответствующих actions.
2. Используйте различные actions, доступные в пакете JSON, для автоматизации задач, связанных

с JSON.
3. Завершите сеанс с помощью action Завершить сеанс для выполнения задания.
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Действия в пакет JSON

пакет JSON включает в себя указанные ниже actions.

Действие Описание

Завершить сеанс См. раздел End session action in JSON.

Получить список узлов См. раздел Get node list action in JSON.

Получить значение узла См. раздел Get node value action in JSON.

Начать сеанс См. раздел Start session action in JSON.

End session action in JSON
You can close a JSON session using the End session action.

Настройки

Завершение сеанса JSON.
• Введите имя сеанса или выберите переменную, используемую в action Начать сеанс.
• Сохраните и закройте сеанс.

Get node list action in JSON
This action enables you to retrieve a list of nodes for a node path.

Настройки

Получение списка дочерних узлов для пути узла.
• Введите ключ или путь к узлу для извлечения нескольких узлов или выберите переменную.
• Введите имя сеанса или выберите существующую переменную, используемую в меню action

Начать сеанс.
• В поле Сохранить результат в переменной выберите переменную типа «Список» для

сохранения выходных данных.

Get node value action in JSON
You can retrieve the node value in JSON.

Настройки

Извлечение значения узла.
• Введите ключ или путь к узлу для извлечения нескольких узлов или выберите существующую

переменную.
• Введите имя сеанса или выберите переменную, используемую в action Начать сеанс.
• В поле Сохранить результат в переменной выберите переменную типа «Строка» для

сохранения выходных данных.
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Start session action in JSON
This action enables you to creates a new JSON session based on a JSON file or specified text.

Настройки

Creates a new JSON session based on a JSON file or specified text.
• Запустите сеанс JSON.
• In the Data Source field, select either File or Text:

• Файл. Выберите тип файла из следующих вариантов: Файл Control Room, Файл рабочего
стола или существующая Переменная.

• Текст. Укажите имя текста или выберите переменную.

Прим.:  Расширения json и .txt поддерживаются для пути к файлу для параметра Рабочий
стол.

• Для создания сеанса JSON из сеанса объекта JSON выберите любую из следующих вкладок.
• Локальный сеанс Укажите имя сеанса, которое можно использовать только в текущем бот.
• Глобальный сеанс Укажите имя сеанса, которое можно использовать для нескольких боты,

например родительских боты, дочерних боты и других дочерних боты родительских боты.
• Переменная. Укажите переменную сеанса, которую можно применить для совместного

использования этого сеанса с другими дочерними боты.

Legacy Automation пакет
The actions in the Legacy Automation пакет are only used in migrated боты to ensure that they run
seamlessly in Automation 360. We do not recommend using this package for new бот development.

Прим.:  If you built a бот using actions from the Legacy Automation пакет from Сборка 5322 or earlier,
the actions will be missing when you open the бот with the default пакет version. You must reinsert the
actions and repopulate the fields.

Expressions

Expressions appear in action input fields. This пакет has the following expressions:

Выражение Описание Use example

DictionaryToStringConverts a dictionary variable to a
string variable

{{$dictionaryVar.LegacyAutomation:dictionaryToString
$}}

The output is a string variable with the
following value: {key1,value1},
{key2,value2}
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Выражение Описание Use example

GetAbsolutePathProvides you the relative path of all
(non-Automation Anywhere) files
present on your system by having a
global variable at the start of the path.
In Enterprise 11 or Enterprise 10,
the equivalent of GetAbsolutePath
is present at Tools > Options >
Runtime Settings > Start in path
of task.
In Enterprise 11 or Enterprise 10,
any folder in the repository can
be used as a starting path for the
GetAbsolutePath value. If the path
in the Enterprise 11 or Enterprise 10
бот is an absolute path, the migration
process does not make any change
to the migrated бот. If the path in
the Enterprise 11 or Enterprise 10
бот is a relative path and contains a
variable, the migration process adds a
global variable at the start of the path
as prefix alongside the relative value
path.

• variable.txt: The input
provided in this example
is a relative path, and the
output will be C:\testing
\variable.txt, where, C:
\testing\variable.txt is a
start-in path.

• \\datashare\variable.txt:
The input provided in this example
is a network path, and the
output will be \\datashare
\variable.txt.

• D:\testing\Automation
 Anywhere Files\Automation
 Anywhere\My Docs
\mydoc.docx: The input
provided in this example is
an absolute path, and the
output will be D:\testing
\Automation Anywhere Files
\Automation Anywhere\My
 Docs\mydoc.docx.

GetBotPath Modifies the value of the бот path
variable in the Enterprise 11 or
Enterprise 10 боты and replaces it
with the relative бот path according
to the Automation 360 repository. The
value of the бот path is based on the
ApplicationPath of the local path
or network path.

• D:\testing\Automation Anywhere
Files\Automation Anywhere\Bots
\My Tasks\test.atmx: The input
provided in this example is an
absolute path, and in this case, the
output path will be My Tasks/
test.

• $AAApplicationPath$\Automation
Anywhere Files \Automation
Anywhere\Bots\My Tasks
\test.atmx: The example provided
in this input is related to
$AAApplicationPath$, and the
output will be My Tasks/test.

• \\Automation Anywhere Files
\Automation Anywhere\Bots\My
Tasks\test.atmx: The example
provided in this input is a network
path, and the output will be My
 Tasks/test.

GetDecrementedNumberDecrements the value of the
respective variable by 1. It is used
mostly in the index positions of list,
record, array or table variables.

$myArray[$Loop-
Counter-1.LegacyAutomation:getDecrementedNumber
$][0]$

The output of myNumber decreases by
1 with each iteration of the loop.
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Выражение Описание Use example

GetIncrementedNumberIncrements the value of the respective
variable by 1. It is used mostly in the
index positions of list, record, array or
table variables.

$Loop-
Counter-1.LegacyAutomation:getIncrementedNumber.Number:toString
$The output of myNumber increases
by 1 with each iteration of the loop.

GetKeystrokeCountCalculates the values of keystrokes in
a phrase/text

Прим.:  A special character, such as
[TAB], [END], or [PAGE DOWN], is
counted as one keystroke.

$KeyStroke-
CharLength.LegacyAutomation:getKeystrokeCount.String:toNumber
$

The output is the average delay for
each keystroke.

GetLegacyIndexValueRetrieves the value from the specific
index position of the list variable in
the боты migrated from Enterprise 11
or Enterprise 10. If the index position
is greater than the size of the list
variable, the system retrieves the
value from the first index position of
the list in the migrated боты

ListToString Converts a list variable to a string
variable.

{{$listVar.LegacyAutomation:listToString
$}}

The output is a string variable
with the following value:
value1,value2,value3

ListToTable Converts a list variable to a table
variable.

{{$my-list-
variable.LegacyAutomation:listToTable
$}}

The output is a table variable where
each list value is cell in a single
column.

ParseLegacyKeysEnsures that the Insert Key
Stroke command of the Enterprise
10/Enterprise 11 боты stored in
variables is successful upon execution.
This expression converts them into
equivalent Automation 360 key strokes
during the execution.

Прим.:  The appearance of some
special characters differs between
Version 11.3 and Automation 360. For
example, the Page Up key appears as
[PAGE UP] in Version 11.3 and [PAGE-
UP] in Automation 360. This difference
does not impact бот function.

$Test.LegacyAutomation:parseLegacyKeys
$
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Выражение Описание Use example

ParseVariableOperationParses the expression provided in
the Enterprise 10/Enterprise 11
Variable Operation command. This
expression ensures that Automation
360 returns the same output as
Enterprise 10/Enterprise 11 боты upon
execution.

$prompt-
assignment.LegacyAutomation:parseVariableOperation
$

TableToString Converts a table variable to a string
variable.
You can also use delimiters such as a
colon, semicolon, or space to separate
the values of the string variable in the
output.

{{$tableVar.LegacyAutomation:tableToString
$}}

The output is a string variable with the
following value: {value1,value2},
{value3,value4}

Use a colon, semicolon, or space as
<"delimiter">:
{{$tableVar.LegacyAutomation:tableToString(<"delimiter">)$}}
For example:

{{$tableVar.LegacyAutomation:tableToString(":")$}}

The output is a string variable with the
following value: {value1:value2}:
{value3:value4}

TableToList Converts a table variable to a list
variable.

{{$DataTable.LegacyAutomation:tableToList(<column_index>)$}}
 For example:
 {{$DataTable.LegacyAutomation:tableToList(2)$}}

The output is a list variable
with the following value:
[value1,value2,value3]

StringToList Converts a string type variable to a list
type variable

$SampleString.LegacyAutomation:stringToList
$

The output is a list variable of size 1
with value same as "SampleString"

StringToTable Converts a string type variable to a
data table type variable

$SampleString.LegacyAutomation:stringToTable
$

The output is a data table variable
with size (1*1) and value at index
[0,0] same as SampleString

Использование предыдущих версий веб-действий
В Automation 360 все команды (кроме «Найти неработающие ссылки» и «Загрузить файлы»)
средства веб-записи перенесены в соответствующие actions в пакет Legacy Automation. Мы не
рекомендуем использовать пакет Legacy Automation для разработки новых бот.
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Веб-actions в пакет Legacy Automation

пакет Legacy Automation включает в себя описанные ниже actions.

Действие Описание

Закрыть страницу Закрывает сеанс браузера для открытого окна или вкладки браузера.

Обновить заголовок
окна

Обновляет заголовок окна во время миграции боты из Internet Explorer
в Microsoft Edge в режиме IE. При выполнении этого action заголовок
окна меняется на формат *Microsoft*Edge. Это action используется
только тогда, когда заголовок окна определяется переменной, а не
когда заголовок окна статичен. Заголовок окна обновляется, когда
запускается бот, а не во время процесса преобразования.
• В поле Окно выберите нужный параметр. Выберите вкладку

Приложение, Браузер или Переменная.
• Приложение. Выберите из списка окон, включая окна

браузера, которые в настоящее время открыты на устройстве
Bot Creator.

• Браузер. Выберите из списка вкладок поддерживаемых
браузеров.

• Переменная. Выберите существующую переменную окна,
чтобы задать заголовок в заголовке окна приложения.

Прим.:  Хотя панель свойств содержит параметры Браузер и
Приложение, во время миграции используется только параметр
Переменная.

• Выберите параметр, чтобы указать, является ли заголовок окна
регулярным выражением.

• Когда выполняется это action, в поле Новый заголовок окна
отображается измененный заголовок окна (Microsoft Edge в режиме
IE).

Выполнить функцию
JavaScript

Выполняет JavaScript внутри веб-страницы в Internet Explorer или
Microsoft Edge (режим IE).
Вы можете выполнить JavaScript внутри веб-страницы, указав
JavaScript в качестве входных данных действия. Когда вы выполняете
функцию JavaScript, можно просмотреть и отредактировать свойства
выбранного iFrame.
• Укажите URL-адрес.
• Укажите имя функции для выполнения и аргументы, которые

нужно передать функции.
• Укажите переменную в разделе Присвоить выходные данные

полю переменной (необязательно).
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Действие Описание

Извлечь данные Извлекает данные с указанного URL-адреса в Internet Explorer или
Microsoft Edge (режим IE).
• Укажите URL-адрес веб-сайта для извлечения данных с

веб-страницы.
• Введите тип и значение элемента управления.
• Если вы хотите повторно использовать существующую вкладку

или окно, установите флажки и укажите свойства Заголовок
страницы или URL-адрес страницы для action.

• Укажите время в секундах в разделе Ожидание создания
элемента управления. По умолчанию время составляет 30
секунд.

• В поле Сохранить результат в переменной выберите
Несколько переменных или Словарь.
• Несколько переменных. Щелкните Добавить привязку

переменной, чтобы связать каждый ключ словаря с
переменной в родительском боте.
Используйте этот параметр, если не хотите использовать actions
для извлечения значений словаря.

• Словарь. Вставьте или создайте переменную словаря
для хранения выходных переменных и значений в парах
«ключ-значение».

Извлечь данные
шаблона

Извлекает данные шаблона со страницы Internet Explorer. Используйте
извлечение данных шаблона, когда веб-записи соответствуют
шаблону. Эта функция распознает шаблон и извлекает данные,
даже если они охватывают несколько страниц. Извлеченные данные
сохраняются в файл CSV.
• Для извлечения данных шаблона введите URL-адрес веб-сайта и

заголовок страницы.
Вы можете предварительно просмотреть извлеченные записанные
данные и их значение.

• Укажите местоположение файла CSV, в который вы хотите записать
данные.

• Выберите параметр, определяющий действие при записи данных в
файл:
• Добавить в файл
• Заменить файл

• Выберите параметр из списка кодировки, чтобы указать кодировку
для файла. По умолчанию установлена кодировка ANSI.
• ANSI
• UTF-8
• Юникод

Извлечь источник Извлекает источник элемента на указанной веб-странице и
присваивает значение переменной.
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Действие Описание

Извлечь таблицу Извлекает таблицу с указанного URL-адреса и при необходимости
сохраняет в новый файл CSV или добавляет в существующий файл
CSV.
• Укажите URL-адрес для открытия веб-страницы в окне Internet

Explorer.
• Укажите номер таблицы для извлечения данных таблицы.
• Укажите местоположение файла CSV, в который вы хотите записать

данные.
• Установите флажок Добавить в существующий CSV-файл при

записи данных в существующий файл.
• Выберите параметр из списка кодировки, чтобы указать кодировку

для файла. По умолчанию установлена кодировка ANSI.
• ANSI
• UTF-8
• Юникод

• Укажите время в секундах в разделе Ожидание создания
элемента управления. По умолчанию время составляет 30
секунд.

• Введите имя сеанса в поле с именем сеанса.
• Если вы хотите повторно использовать существующую вкладку

или окно, установите флажки и укажите свойства Заголовок
страницы или URL-адрес страницы для действия.

• Укажите сведения о тегах (имя тега и имя атрибута) извлеченных
данных таблицы и сохраните результат в файл CSV или присвойте
выходные данные переменной таблицы данных.

Назад Переходит на предыдущую страницу.

Управление
веб-элементами
управления

Определяет свойства элемента управления пользовательского
интерфейса с указанного веб-сайта.
• Выберите параметр для открытия нового URL-адреса или

выбора страницы.
• Вы можете задать критерии поиска объекта на снимке. Выполните

поиск объекта, указав Имя элемента управления, Значение
или Индекс.

• Если вы хотите повторно использовать существующую вкладку
или окно, установите флажки и укажите свойства Заголовок
страницы или URL-адрес страницы для action.

• Выберите тип элемента управления из раскрывающегося меню.
• Укажите время в секундах в разделе Ожидание создания

элемента управления. По умолчанию время составляет 30
секунд.

• Выберите переменную, чтобы присвоить выходные данные
переменной.
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Действие Описание

Перейти на страницу Открывает веб-страницу в существующем окне Internet Explorer.
• Укажите URL-адрес в поле Перейти по URL-адресу, чтобы

открыть новое окно с указанным URL-адресом.
• Если вы хотите заменить существующую вкладку или окно,

установите флажки и укажите свойства Заголовок страницы или
URL-адрес страницы для действия.

Открыть страницу Открывает веб-страницу в Internet Explorer с указанным URL-адресом.
• Укажите URL-адрес для открытия веб-страницы в окне Internet

Explorer.
• Если вы хотите повторно использовать существующую вкладку

или окно, установите флажки и укажите свойства Заголовок
страницы или URL-адрес страницы для действия.

Поиск по подписи Выполняет поиск первого открытого окна Internet Explorer для
указанной подписи и частоты периодичности. Вы можете обновить
Подпись и Периодичность в бот.

Настроить параметры Установите параметр конфигурации для веб-actions. Можно выбрать
любой из указанных ниже параметров или их все.
Когда вы настроите это action со следующими настройками,
выбранные настройки будут применяться ко всем actions в веб-группе.
• Запустите Internet Explorer как процесс.
• Откройте браузер в фоновом режиме.
• Запустите Internet Explorer в режиме совместимости с Edge.

Прим.:  При установке флажка Запустить Internet Explorer в
режиме совместимости с Edge вся автоматизация, которую
вы создали ранее в Internet Explorer 11 с помощью веб-actions,
будет запускаться и работать в Microsoft Edge в режиме IE. actions
в веб-группе запускаются без проблем в Microsoft Edge в режиме
IE.

Список пакет
The List пакет contains actions that enable you to perform various operations on a variable of the list data
type.

Working with variables of list data type

A list is a collection of ordered values. The values can be of Boolean, number, or string data subtype.
When initializing a list variable, you can select the Any data subtype in order to hold any of the three data
subtypes. You can manually enter values by creating a new variable or selecting an existing one from the
Variables menu, and then clicking Add.
Common uses of list variables include:
• Sending an email to multiple recipients.
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• Searching multiple web addresses.

Действия in the List пакет

If you are using a List action in a Loop action, you must use the For each item in the list iterator.
The following actions are available in the List пакет:

Действие Описание

Add item См. раздел Add item action in Список.

Append См. раздел Append action in Список.

Assign См. раздел Assign action in Список.

Clear См. раздел Clear action in Список.

Get item См. раздел Get item action in Список.

Join items См. раздел Join items action in Список.

Remove item См. раздел Remove item action in Список.

Set item См. раздел Set item action in Список.

Size См. раздел Size action in Список.

Пример

Create a бот to add items to a list and retrieve data from a list. To achieve this functionality, perform the
following steps:
1. Create a бот.

a. На левой панели щелкните Автоматизация.
Отобразится список доступных боты и форм.

b. Щелкните Создать бота.
c. Enter the бот name: ListBot
d. Щелкните Создать и редактировать.
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2. Create the following variables.
• Variable: StringList

• Тип: Список
• Subtype: Строка
• Name: StringList
• Default value at 0: Automation
• Default value at 1: Anywhere

• Variable: SampleString

• Name: SampleString
• Default value: PvtLtd

• Variable: ListOutput

• Тип: Любое
• Name : ListOutput

3. To insert an item into a list variable, from the Actions pane, double-click or drag the List > Add item
action.
a. In the List variable field, select StringList.
b. In the Items to be added field, select SampleString.
c. To insert the item at the end of the list, select the To end of list option.

4. To retrieve a value at a specified position in a list, from the Actions pane, double-click or drag the List
> Get item action.
a. In the List variable field, select StringList.
b. In the Index number field, enter 0. This is to specify the position in the list from where you

want to retrieve a value.
c. To store the output from Assign the output to variable list, select ListOutput.

5. To print the value of the Index 0, double-click or drag the Message box action. Click Save and Run.
The бот displays the zero index data of the list variable, which is Automation.

Ссылки, связанные с данной
Цикл пакет
Use the Цикл package to run a sequence of actions repeatedly for a specific number of times or until a
specific condition is met.
Variables overview
Automation 360 offers a variety of variables, each designed to hold specific types of data and is intended
for specific use. Use the topics below to learn more about each variable and how to use them.

Add item action in Список
The Add item action enables you to insert an item into a list variable.
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Настройки

You can choose to add the item at the end of the list or specify a position in the list.
• Select the list variable in which to add an item from the List variable list.
• Select the variable that contains the value to add from the Item to be added list.

Прим.:  The variable must be of the same sub-data type as the other list items.

• Select the To end of list option to insert the item at the end of the list or select At list index to
specify the index in the list where to insert the item.
The list index starts from 0. The first item in the list is at position 0, the second item at 1, and so on.
For example, to add an item at the fourth position in a list, enter 3 in the At list index field.

Append action in Список
The Appendaction enables you to add a list variable into the column index of a data table.

Настройки

You can choose to add the list variable at the start or end, or specify a position in the data table.
• Select the list variable that contains the value to be added.
• In the Assign the outcome to Data Table field, select a table variable that you want to use to store

the output.
• Choose from the following options to insert a column at index:

• First index: Sets the value to the first position (0 index) in a data table.
• Last index: Sets the value at the end of the data table.
• Specific index: Specify the index where you want to enter the column index. For example, to set a

value to the first column, enter 0.
The index number starts from 0. The first item in the data table is at position 0, the second item
at 1, and so on. For example, to add an item at the third position in a data table, enter 2 in the
Specific index field.

Assign action in Список
The Assign action enables you to assign the value of the source list to the destination list variable.

Настройки

• On the List tab, select the source list variable from the drop-down list and specify a value in the Value
at 0 field or create a new list variable.

• On the Variable tab, insert a value for the list variable.
• Select a destination list variable or create one to hold the output.

Clear action in Список
Use the Clear action to clear all items from the selected list variable.
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Настройки

Select the list variable from which you want to clear the items.

Get item action in Список
You can retrieve a value at the specified position in a list and store the output to a variable using the Get
item action.

Настройки

• Select the list variable from which you want to retrieve a value from the List variable list.
• Specify the position in the list from where you want to retrieve the value in the Index number field.

The list index starts from 0. The first item in the list is at position 0, the second item at 1, and so on.
• Select a variable that you want to use to store the output from the Assign the output to variable

list.

Join items action in Список
The Join items action enables you to combine all the available values in a list variable and store the
output to a string variable.

Настройки

Combines all the available values in a list variable and stores the output to a string variable. You can
specify the delimiter you want to use as a separator in the output.
• Select the list variable that you want to use from the List variable list.
• Specify the delimiter you want to use to separate values in the output in the Delimiter field.
• Select a variable that you want to use to store the output from the Assign the output to variable

list.

Remove item action in Список
The Remove item action enables you to remove an item from a list and assign the output to a variable.

Настройки

• Select the list variable from which you want to remove an item from the List variable list.
• Specify the position in the list from where you want to remove the value in the Index number field.

The list index starts from 0. The first item in the list is at position 0, the second item at 1, and so on.
• Select a variable that you want to use to store the output from the Assign the output to variable

list.

Set item action in Список
You can set an item at the specific position in a list and store the output in a variable using the Set item
action.
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Настройки

• Select the list variable in which you want to set a value from the List variable list.
• Specify the position in the list where you want to set the item in the Index number field. The list

index starts from 0. The first item in the list is at position 0, the second item at 1, and so on.
• Select a variable from the drop-down list in the Replace with field to replace the list variable.
• Select a variable that you want to use to store the output from the Assign the output to variable

list.

Size action in Список
The Size action enables you to retrieve the number of items in a list and assign the output to a number
variable.

Настройки

• Select the list variable for which you want to retrieve the size from the List variable list.
• Select a number variable that you want to use to store the output from the Assigns the number of

items to variable list.

Записать в файл пакет
Use the Записать в файл пакет to create a log file with data.
The Записать в файл пакет enables the following:
• Verify that a бот ran properly.
• Create a new log file.
• Specify custom text to be included in the log file.
• Add a time stamp to the log file.
• Use a log file as a variable.

Прим.:  The пакет supports ANSI, Unicode, and UTF8. It can save files as .csv and .txt.

Действия в Записать в файл пакет

пакет Записать в файл включает в себя указанные ниже action.

Действие Описание

Записать в файл См. раздел Using Log to file action.

Using Log to file action
The Log to file action in the Записать в файл пакет enables you to create a log file with data about the
events that occur when a TaskBot runs.
Follow these steps to log text into a file:
1. In the Действия palette, double-click or drag the Log to file action from the Записать в файл

пакет.
2. In the File path field, specify the file location or variable.
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3. In the Enter text to log field, enter the text to log in the file.
4. Select the Append timestamp check box to add a time stamp.
5. In the When logging field, choose Append to existing log file to append the log file or

Overwrite existing log file to overwrite the content in the log file.
6. Select the Encoding type.

• ANSI: Used to encode Latin alphabet.
• UNICODE
• UTF8: Can encode all possible characters.
• UTF-16LE: Inserts a byte order mark (BOM) Unicode character at the beginning of the file.

Прим.:  Shift-JIS files must use ANSI as encoding to read text file content.

If you selected the Append to existing log file option in Step 5, ensure that the selected encoding
type matches that of the original file, otherwise some of the characters might not be logged.

7. Щелкните Сохранить.

Цикл пакет
Use the Цикл package to run a sequence of actions repeatedly for a specific number of times or until a
specific condition is met.
The Цикл пакет enables you to repeatedly run specific actions within a бот. For example, repeat the set
of actions that read data from each row of a Microsoft Excel file, rename all files in a folder, and save each
email in a mailbox. You can also use the If action within the Цикл action to validate a condition, and based
on the outcome of it, skip the current iteration in the loop or even break the loop.
For conditional loops, different actions are taken depending on whether the conditional parameters are
met. For loops that have a specified number of iterations, the loop exits on the last iteration and goes to
the next step in the бот.
When you run a sequence of actions repeatedly for a specific number of times within a loop, the end
condition within the loop is evaluated in every iteration.
For example, when you loop through a Таблица данных that has 10 columns, enter dynamic values of
column count for the end condition in the loop, use the Data Table > Delete column action to delete
the column of index 0 inside the loop body, and then run the бот, the бот deletes a column in every
iteration. Hence it reduces the iteration count because the loop end condition is evaluated in each iteration.

Действия в Цикл пакет

The following Цикл actions are available:

Action Описание

Цикл См. раздел Using Цикл action.

Продолжить См. раздел Continue action.
См. раздел Если пакет.

Прервать См. раздел Break action.
См. раздел Если пакет.
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Iterator-related conditions within the Цикл action

Select the Iterator option to specify the number of times the set of actions will be repeated as part of the
Цикл action:

Итератор Описание

For each row in CSV/
TXT

Repeats the set of actions for each row in the specified CSV or text file
and assigns the values in the current row to a record variable. См. раздел
Using the For each row in CSV/TXT iterator.

For each row in
Таблица данных

Repeats the set of actions for each row in the specified table and assigns
the values in the current row to a record variable. См. раздел Using the For
each row in table iterator.

Для каждой строки
в наборе данных
SQL-запроса

Repeats the set of actions for each row in the specified SQL query dataset
and assigns the values in the current row to a record variable. Provide
the session name that you have used to establish a connection with the
database.

For each key in the
Словарь

Repeats the set of actions for each key in the specified Dictionary variable
and assigns the name of the current key to a variable.

Прим.:  When a бот runs a Loop action that contains a Dictionary >
Put action, the бот only iterates on the original number of items in a
dictionary; it ignores items inserted using the Put action.

For each value in the
Словарь

Repeats the set of actions for each value in the specified Dictionary
variable and assigns the current value to a variable. Because this variable
type can hold various subtypes (String, Number, Boolean, and so on), if
you quick-create a variable when configuring the action, the variable is of
Any type.

Прим.:  When a бот runs a Loop action that contains a Dictionary >
Put action, the бот only iterates on the original number of items in a
dictionary; it ignores items inserted using the Put action.

For each mail in
mailbox

Repeats the set of actions for each email in the specified mailbox. См.
раздел Using the For each mail in mail box iterator.
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Итератор Описание

For each row in
worksheet (Базовый
Excel or Расширенный
Excel)

Repeats the set of actions for each row that contains data in a worksheet
and assigns the values in the current row to a record variable. Provide
the session name that you have used to open the Базовый Excel or
Расширенный Excel worksheet. Specify whether to repeat the actions
for all the rows, specified rows, or a specified cell range. Select a record
variable from the Assign the current row to this variable list or create
a new one. См. раздел Переменная записи.
This iterator retrieves cell values as string data types. It supports Excel cell
formats, including Number, Percentage, Currency, Scientific, and Date. For
example, a value from a cell of Currency formatting retains the currency
symbol when passed to a table or record variable.
• You must convert the values to perform non-string operations.
• In Расширенный Excel, when you choose loop iterator as For each

row in worksheet, you have a Read option to read either the visible
text or value of the cell.
Например, если ячейка содержит значение 70%, параметр
Прочитать значение ячейки прочитает значение как 70,
игнорируя формат %, в то время как Прочитать видимый текст
прочитает содержимое как 70%.

Recommendation:  Use the Read cell value option as reading value
from a cell for better performance than reading visible text.

Use of Global session option to share an Microsoft Excel session using
the Расширенный Excel пакет is not available with this option.
Alternate solution: Use the Get multiple cells action and save the
data into a datatable variable and then, use the Цикл пакет with the Data
Table option selected.

Для каждого файла в
папке

Repeats the set of actions for each file in the specified folder and assigns
the properties of the current file to a Dictionary variable containing two
keys: the name key holds the file name and the extension key holds the
file extension.
To open files with different extensions, use the variable option to assign
the folder path, file name, and file extension . First, create a variable for
the folder path, $sFolder$. Then, for the files in the folder path, create
two variables, one for file name $name$ and another for file extension
$extension$. To open a file, combine the variables as a string, such
as $sFolder$\$name$.$extension$. For the extension to work with
different file types and different open options, you can add conditional
logic.

Для каждой папки в
папке

Repeats the set of actions for each folder in the specified folder and
assigns the current folder name to a String variable.
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Итератор Описание

Для каждого
элемента в списке

Repeats the set of actions for each item in the specified list and assigns
the current item to a variable. Specify whether to repeat the action for
all items in the list or only for the range of items in the list. Because this
variable type can hold various subtypes (String, Number, Boolean, and
so on), if you quick-create a variable when configuring the action, the
variable is of Any type.

Прим.:  The index in a list starts from zero. For example, to repeat the
action for items from the third position to the sixth position of the list,
specify 2 and 5 in the appropriate fields.

n раз Repeats the actions in the container the specified number of times. You
can assign the iteration count to a Number variable.

Для каждого
значения в записи

Repeats the actions for each value in the specified record and assigns the
current value to a variable. Because this variable type can hold various
subtypes (String, Number, Boolean, and so on), if you quick-create a
variable when configuring the action, the variable is of Any type..

Для каждого
собрания в календаре

Use this option to repeat the set of actions for each meeting in the
specified calendar. См. раздел Using Office 365 Calendar actions in a loop.

For each row in
worksheet (Office 365
Excel)

Repeats the set of actions for each row that contains data in a worksheet.
• Provide the session name that you have used to open the worksheet.
• Specify whether to repeat the actions for all the rows or specific rows.
• You can assign the values in the current row to a record variable.

For each node in a
XML dataset

Repeats the set of actions for each node in an XML dataset and assigns
the current node to String variable. Provide the session name that you
have used to open the XML file.

While related conditions in the Цикл action

You can configure multiple while related conditions within a single Цикл action:
1. Click Add condition.
2. Select either of the following options:

• And: Both of the conditions must be met for the actions to run.
• Or: Either of the conditions must be met for the actions to run.

3. Select the conditions from the drop-down list.

Select the While option to use the following conditions:
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While Описание

Приложение Use the Application is running or Application is not running
condition to run actions based on whether an application is running or not
running.
Enter the application path or specify the path using a variable along with
the amount of time to wait (in seconds) for the condition to be true.

Прим.:  The Application is running and Application is not running
conditions are not applicable for Internet Explorer боты because its
corresponding process iexplore.exe runs in the background when
Microsoft Edge is launched in IE mode.

Логический Use this condition to execute actions based on the value of a Логический
variable. Use this condition to compare the values of two Boolean variables
or one Boolean variable to a selected Boolean value.

Data table Use the Data table is empty condition to execute actions based on
whether the specified table contains values.
Use the Number of rows and Number of columns conditions to
execute actions based on whether the number of columns or rows is
Equal to, Greater than, or Less than the specified value.

Дата/время Use the Datetime variable condition to execute actions based on
whether the value of the source datetime variable is Equal to or Not
Equal to, is Greater than or Equal to, or is Lesser than or Equal to
the value of the target datetime variable.

Словарь Use this condition to repeat the set of actions based on whether the
selected dictionary variable contains the specified key.

Прим.:  The key comparison is case-sensitive.
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While Описание

Файл Use the following conditions to execute the action:
• File date

Use this condition to verify the date and time when a file was created
or modified. Specify a date or date range using the On a date, Is
within last, Is between, or Is before options. For the On a date
option, specify a date to verify whether the file was created or modified
on that date. For the Is within last option, specify the number of days
or time (in hours, minutes, and seconds). Enter the amount of time (in
seconds) to wait for this condition to be true.

• File exists and File does not exist
Use these conditions to execute an action based on whether a file
exists. For example, if a data file exists, format the file and upload it to
a database.

• File extension
Use this condition to check the file extension of a selected file and then
execute actions based on the results. Use the File path field to select a
file.

• File size
This condition verifies if the specified file is larger, smaller, not the
same, or the same as the size you specify.
Enter the amount of time (in seconds) to wait for this condition to be
true.

Папка does or does
not exists

Use these conditions to repeat the set of actions based on whether a
folder exists.

Распознавание
изображений

Use these conditions to verify whether:
• Image file is found in the Image file or not.
• Image file is found in the Window or not.
• Window is found in the Image file or not.
• Window is found in the Window or not.

For the Window conditions, you can use the Resize window option to
specify the window dimensions. This option delivers a more reliable бот.
It resizes the window to the dimensions at which the task was recorded,
which enhances the bot's ability to identify the target object.

Прим.:  This option is only available for windows that can be resized. It is
not available for Desktop or Taskbar options.

For the Window conditions, you can use the Preview option to select a
specific captured occurrence and position your click location relative to the
image.

JavaScript Use the Script is successful or Script is unsuccessful condition to
execute actions based the status of the specified JavaScript. Select the file
that contains the script and optionally specify the parameters by selecting
a list variable.
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While Описание

Автоматизация
предыдущих версий

The Legacy automation conditions are only used in migrated боты
to ensure that they run seamlessly in Automation 360. We do not
recommend using these conditions for new бот development. The
following conditions to verify the following:
• Whether Web control exists or not.
• Whether Window control exists or not.
• Whether Window control is active or not.
• Whether Script is successful or not.
• Whether Child window exists or not.

For the Window control conditions, you can use the Resize window
option to specify the window dimensions. This option delivers a more
reliable бот. It resizes the window to the dimensions at which the task was
recorded, which enhances the bot's ability to identify the target object.

Список Use the List variable condition to execute actions based on whether
the specified list variable contains a particular value. The value can be of
Number, String, or Boolean data type.

Число Use the Number variable condition to execute actions based on whether
the specified number variable is Equal to or Not Equal to, or is Greater
than or Equal to, or is Lesser than or Equal to a particular value.

Ping Use the Ping is successful or Ping is unsuccessful condition to verify
if a machine or server is running, and execute actions based on the result.
Enter the amount of time (in seconds) to wait for the condition to be true.

Средство записи • Use the Object exists condition to detect an object in a window.
Select a window or variable to capture the object. Enter the amount of
time (in seconds) to wait for this condition to be true, that is, for the
object to be detected.

• Use the Object does not exist condition to verify whether a specific
object exists in a window, and then based on the result, execute
actions. Enter the amount of time (in seconds) to wait for this condition
to be true. For example, you can use the Object does not exist
condition inside the Loop > While condition to make sure that the
бот does not execute the next action until the object on the business
application is loaded.

Прим.:  The Object exists and Object does not exist Recorder
conditions support Chromium-based Microsoft Edge with Internet Explorer
mode.

Служба Use the Service is running or Service is not running condition to
execute actions based on whether a service is running or not. Select
Service list to choose a service from the list of available services.
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While Описание

Строка Use the String variable condition to execute actions based on whether
the specified source string value is Equal to or Not equal to, or
Includes or Does not include the target value.
You can select the Match case option to only execute actions if the two
strings have matching uppercase and lowercase letters.
When you extract text from a Microsoft application, the extracted text
contains the /r/n special characters which indicate a new line. Select
the Ignore Carriage return option if you want to ignore the /r special
character when you compare the text.
To create a condition based on whether a string is empty or not empty,
compare the source value to an empty target field using the Equal to
operator.
См. раздел Example of using a conditional statement.

TaskBot Use the Task successful or Task unsuccessful condition to execute
actions based on the status of the specified TaskBot.

VBScript Use the Script is successful or Script is unsuccessful condition
to execute actions based on the status of the specified Visual Basic
script. Select the file that contains the script and optionally specify the
parameters by selecting a variable.

Окно Use the Window exists or Window does not exist condition to verify
if a specific application window is open by entering the Window title or
using a variable. Enter the amount of time (in seconds) to wait for the
condition to be true. These conditions are used when the window title
remains constant and to verify if the specific window is open and execute
further actions based on the output.
Use the Window with same title does not exist or Window with
same title exist condition to verify whether a window with the same title
exists or whether the window title has changed. Enter the amount of time
(in seconds) to keep verifying if the condition is true. These conditions are
used for window titles that are dynamic. For example, when you open a
Google account webpage, enter your username and password to log into
your account, the window title changes. If you want to compose a new
email as a next action, you can use these conditions before you execute
the next action to verify if the window with the same title exists or if the
title has changed.

Задачи, связанные с данной
Example of transferring data from CSV file to Excel worksheet
In this example, you build a бот to update the product inventory in an Excel worksheet with new product
names from a CSV file. Use actions from the CSV/TXT, Расширенный Excel, IF/ELSE, and Цикл пакеты.
Example of entering data into a web form from a worksheet
In this example, you build a бот to enter multiple rows of data from an XLSX sheet into a web form. Use
actions from the Расширенный Excel, Цикл, and Средство записи пакеты.
Ссылки, связанные с данной
Переменная записи
A record variable holds a row of data extracted from a database, spreadsheet, or table in name-field pairs.
The fields can store values of Boolean, datetime, number, or string data type.
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Информация, связанная с данной
Using loops to control a bot

Continue action
The Continue action in the Цикл пакет enables you to continue the loop in your operation.

Настройки

Use the Continue action along with the If action to skip the current iteration and continue with the next
iteration in the loop based on the condition you have specified in the If action.

Break action
The Break action in the Цикл пакет enables you to terminate the loop in your operation.

Настройки

Use the Break action along with the If action to terminate the loop based on the condition you have
specified in the If action. When you terminate the loop, the actions immediately following the Loop action
run.

Using Цикл action
Use the Цикл action to repeatedly run a sequence of actions for a specific number of times or until a
condition is met.
To repeatedly run a sequence of actions, do the following:
1. Double-click or drag the Loop action from the Actions palette.
2. Set the desired conditions for the loop.

Вариант Действие

Select the Iterator option to repeat the
sequence of actions for a specific number
of times.

Select an option from the Iterator list to specify
how many times the sequence of actions is to be
repeated.
See Цикл пакет for the list of available options.

Select the While option to repeat the
sequence of actions until a condition is
met.

a. Select an option from the Condition list to
specify the condition.

b. Select the Check the condition at the
end of the iteration to validate the
condition at the end of each iteration. This
option enables you to ensure that the set
of actions run at least one time, even if the
condition is not met.

3. Double-click or drag the actions to be repeated within the Loop.
4. Необязательно: Double-click or drag the Continue action from the Loop пакет to skip the current

iteration and continue with the next iteration of the loop.
5. Щелкните Сохранить.
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Using the For each row in CSV/TXT iterator
Use the For each row in CSV/TXT iterator in the Цикл action to read the data of each row in a CSV or
text file and assign the current row to a record variable. The бот reads the values in each cell as string-
type values, even if there are numerical values.
First, open the CSV or text file. Using the Open action for CSV/TXT file

Прим.:  The For each row in CSV/TXT iterator only supports CSV/TXT files that conform to the RFC
4180 standard. For more information about the standard, see Common format and MIME type for CSV files.

To use the For each row in CSV/TXT iterator in a Loop action, do the following:
1. Double-click or drag the Loop action from the Loop пакет in the Действия palette.
2. Select the For each row in CSV/TXT option from the Iterator list.
3. Enter the name of the session that you have used to open the CSV or text file in the Open action.
4. Select a record variable from the Assign the current row to this variable list or create a new one.

Прим.:  If you select an existing record variable, ensure that the column headers capitalization in the
CSV or text file match that of the schema of the record variable. Schema

Insert actions to use the values from the CSV or text file in your automation. Use the record variable to
retrieve the values by index number or column name. For example, if the first column of the file is titled
EmployeeID, to retrieve the value of the first cell of each row enter $rYourVariableName[0]$ or
$rYourVariableName{EmployeeID}$.

Прим.:  You must select the Contains header option in the CSV/TXT > Open action to specify the
record values by column name.

For an example, see Build a Bot Insight dashboard бот.

Using the For each row in table iterator
Use the For each row in table iterator in the Цикл action to read the data of each row in a table variable
and assign the current row to a record variable.
First, retrieve the table values and store them to a table variable.

Example:  Example of extracting data from a web table

To use the For each row in table iterator in a Loop action, do the following:
1. Double-click or drag the Loop action from the Loop пакет in the Действия palette.
2. Select the For each row in table option from the Iterator list.
3. Select the variable that holds the values from the Table variable list.
4. Select a record variable from the Assign the current row to this variable list or create a new one.
5. Щелкните Сохранить.

Insert actions to use the values from the data table in your automation. Use the record variable to
retrieve the values by index number or column name. For example, if the first column of the file is titled
EmployeeID, to retrieve the value of the first cell of each row enter $rYourVariableName[0]$ or
$rYourVariableName{EmployeeID}$.
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Message box package
Use the Message box action from the Message box package to insert a message box that shows a
message when the task runs. For example, you can insert a Message Box action to follow a web form so
that the action displays the message: Web Form Filled and Complete.
Подробнее см. в разделе Using the Message box action.
Use the following examples to learn how to use the Message box action when building automations.
• Build a Go be Great бот

Build a basic TaskBot using a Message Box action and a variable.
• Build a basic бот that uses a desktop application

An example of how to build a basic TaskBot that uses the calculator application.

Using the Message box action
The Message box action in the Message Box пакет enables you to insert a message box that shows a
message when the task runs.
1. Double-click or drag the Message box action from the Message box package in the Действия

palette.
2. In the Enter the message box window title field, enter a window title for the message box.
3. In the Enter the message to display field, enter a message that you want the бот to display.

This field holds up to 65535 alphanumeric characters, and empty values.

Прим.:  Чтобы предоставить строку, которая содержит знак доллара ($), необходимо ввести два
знака доллара. For example, if you enter Pay $$5.00, the output will be Pay $5.00.

4. In the Scrollbar after lines field, specify the number of lines at which you want to show a scroll bar.
5. Необязательно: Select the Close message box after option and specify the number of seconds

after which you want the message box to close automatically.

Важное замечание:  Select this check box if the бот will run on an unattended machine.

6. Щелкните Сохранить.

Microsoft LUIS NLP пакет
The Microsoft LUIS NLP пакет contains actions that enable you to connect to and consume the
Microsoft Cognitive Services Text Analytics API to identify the language, sentiment, key phrases, and
entities. This пакет supports the following languages: English, Chinese (Simplified), French, German, and
Spanish.

Важное замечание:  This is a beta пакет and is currently not available with the Automation 360
Enterprise and Cloud editions.

Перед началом работы

You must have an Azure Cognitive Services resource to use these actions. See Create a Cognitive Services
resource using the Azure portal.
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You also require the following in order to use the actions:
• Service Endpoint URL: the endpoint URL that identifies the Azure service.
• Subscription Key: the unique key that authenticates Automation Anywhere Enterprise.

Действия in the Microsoft LUIS NLP пакет

Действие Описание

Detect language Identifies the language of the provided content and returns it in ISO 639-1
language code. The output is stored in a string variable.

Get key phrases Identifies the main points and returns a list of key phrases. For example, if
the input text is about a basketball game, this action returns the names of
teams, the name of the venue, and the final score.

Get named entities Identifies the entities in the provided content such as people, places,
organizations, date/time, quantities, branded products, and book titles.
The output is stored in a dictionary variable, where each name is a key,
and the corresponding entity is the value.

Get sentiment Analyzes the provided content and returns a sentiment and score.
• If the score is greater than 0.6, the sentiment is Positive.
• If the score is in the 0.2 through 0.6 range, the sentiment is Neutral.
• If the score is less than 0.2, the sentiment is Negative.

The output is stored in a dictionary variable containing two keys and their
corresponding values: sentiment and score.

Мышь пакет
Use the Мышь пакет to simulate mouse actions.

Automation 360 extension setting

If the бот execution takes longer when you use the Мышь пакетto simulate mouse actions a static page
running on the Google Chrome or Microsoft Edge browser, then follow these steps to enable the setting in
the Automation 360 extension:
• Click the extensions icon at the top right corner of the browser window.
• Click the vertical ellipses next to the  plugin and select Manage extension.
• Enable the Allow access to file URLs option.
• Restart the browser and run the .

Действия в Мышь пакет

пакет Мышь включает в себя указанные ниже actions.
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Действие Описание

Щелчок См. раздел Using the Click action.

Переместить См. раздел Using the Move action.

Прокрутка См. раздел Using the Scroll action.

Безопасная запись

Если включен режим безопасной записи, боты не отображают изображения целевых объектов после
съемки. Это гарантирует, что конфиденциальные данные не будут показаны.

Прим.:  Несмотря на то, что боты не отображают целевые изображения после записи, изображения
все еще хранятся в памяти Control Room, потому что они необходимы для запуска боты.

Когда вы записываете задание в режиме безопасной записи, в окне Предварительный просмотр
временно отображается изображение захваченной области. Это изображение будет скрыто после
того, как вы переместитесь за пределы окна Bot editor или обновите его.
Этот параметр должен быть включен пользователем с полномочиями администратора. См. раздел
Настройки.
Ссылки, связанные с данной
Screen resolution dependent пакеты
The screen resolution between the Bot Runner and Bot Creator device should be consistent as when
resolution-dependent пакеты are used to build боты, any screen resolution difference between the Bot
Creator and Bot Runner device will impact the боты during runtime.

Using the Click action
The Click action in the Мышь пакет enables a бот to simulate mouse clicks. This action enables to
capture the UI element such as the screen or window, and to specify the click event and click button.
Ensure that the screen scale and resolution of the Bot Creator device is the same as the Bot Runner
device. If the screen scale and resolution are different, the бот might fail when deployed to the Bot Runner
device.
If you are using Internet Explorer, the бот waits until the browser is completely rendered and is in a ready
state before executing the Click action.
Follow these steps to add a Click action:
1. In the Действия palette, double-click or drag the Click action from the Мышь пакет.
2. Specify the window in which to capture the mouse click:

Choose from the Application, Browser, or Variable tab.
Вариант Описание

Приложение Select from a list of currently active windows.

Прим.:  You can use the Screen option to
capture coordinates on the device screen,
however we recommend specifying a window
because screen sizes can change, which distorts
the captured coordinates.
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Вариант Описание

Браузер Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based
, and  browsers.

Переменная Выберите существующую переменную окна,
чтобы задать заголовок в заголовке окна
приложения.

Прим.:  This option deactivates the Capture
option. Use this option only after you have
completed the capture step.

Вставьте символ подстановочного знака (*) в поле Заголовок окна для поиска заголовков
окон, которые могут меняться. You can specify one or more wildcards (*) at the start, middle, or
end of the value.For example, to perform an operation on any window that has Microsoft in the
title, use a wildcard to indicate any string by adding it before or after the value: *Microsoft*. The 
first searches for the exact window title (Microsoft), and if it does not find a match, it searches for
windows with the term Microsoft anywhere in the title.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.
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3. Необязательно: Select the Resize window option to specify the window dimensions.
This option delivers a more reliable бот. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the ботto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Прим.:  This option is available only for windows that can be resized. It is not available for the
Desktop or Taskbar options.

4. Click Capture coordinate.
The selected window appears.

5. Drag the mouse to select the click spot and left-click to capture it.
The captured spot appears in the Preview section with the coordinates underneath.

6. In the Button option, specify the button to click.
Choose from Left Button, Right Button, or Middle Button.

7. In the Event option, specify the event.
Choose from Click, Double click, Button up, or Button down.

8. Щелкните Сохранить.

Using the Move action
The Move action in the Мышь пакет enables you to simulate moving the mouse pointer from one location
to another.
Follow these steps to add a Move action:
1. In the Действия palette, double-click or drag the Move action from the Мышь пакет.
2. In the Mouse from and Mouse to fields, specify the X and Y coordinates.
3. Click Capture coordinate to capture the starting point location.
4. Click Capture coordinate to capture the end point location.
5. Необязательно. In the Delay in milliseconds field, specify the total duration of the movement in

milliseconds.
6. Щелкните Сохранить.

Using the Scroll action
The Scroll action in the Мышь пакет enables you to simulate scrolling the mouse wheel up or down.
Follow these steps to add a Scroll action:
1. In the Действия palette, double-click or drag the Scroll action from the Мышь пакет.
2. In the Select scroll option, select the Up or Down option.
3. In the Number of iterations field, specify the number of times to scroll.
4. Необязательно: In the Delay in milliseconds field, specify the total duration of the scrolling in

milliseconds.
5. Щелкните Сохранить.
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Число пакет
пакет Число содержит actions, позволяющие выполнять различные операции с числовыми
переменными. В числовых переменных хранятся числовые значения, включая целые и десятичные
числа. В них хранятся значения от -9 223 372 036 854 775 808 до 9 223 372 036 854 775 807 и до 15
десятичных разрядов.

Действия в Число пакет

actions в пакет Число принимают переменную в качестве входа и присваивают переменной
выходное значение. Эти actions позволяют присваивать значения числовым переменным, уменьшать
или увеличивать числа или преобразовывать числовые переменные в строковые переменные.
Для выполнения математических операций можно использовать большие числа в числовых
переменных или в actions. В редакторе ботов в меню действий (вертикальное многоточие в правом
верхнем углу) выберите пункт Расширенные настройки > Включить улучшенную поддержку
чисел.

Прим.:  Для использования этой возможности необходимо обновить пакет до последней версии.

пакет Число включает в себя описанные ниже actions.

Действие Описание

Присвоить См. Assign action in Число

Декремент См. Decrement action in Число

Инкремент См. Increment action in Число

Random См. Random action in Число

В строку См. To string action in Число

Assign action in Число
The Assign action in the Число пакет enables you to assign a specified number or result of an expression
to a user-defined Number variable. Вы можете использовать выражения, построенные с помощью
операторов +, -, * и /, а также группировать выражения с помощью круглых скобок. Например,
(3*4)+5 или ($Переменная2*$Переменная3)/$Переменная1.

Настройки

• In the Select the source number variable/value, enter a number or select a predefined Number
variable.

• In the Select the destination number variable, select a predefined Number variable or create a new
one to hold the output.

Decrement action in Число
The Decrement action in the Число пакет enables you to decrement (decreases by set intervals) a number
by a user-specified value.
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Настройки

• In the Enter number field, enter a number or select a predefined Number variable.
• In the Enter decrement value field, enter the decrement value or select a predefined Number

variable.
• In the Assign the output to variable field, select a predefined Number variable or create a new one

to hold the output.

Increment action in Число
The Increment action in the Число пакет enables you to increment (increases by set intervals) a number
by a user-specified value.

Настройки

• In the Enter number field, enter a number or select a predefined Number variable.
• In the Enter increment value field, enter the increment value, the value must be greater than zero or

select a predefined Number variable.
• In the Assign the output to variable field, select a predefined Number variable or create a new one

to hold the output.

Random action in Число
The Random action in the Число пакет enables you to generate a random integer from a user-specified
range and assign it to a number variable.

Настройки

• В поле Начало диапазона введите число или выберите предварительно определенную
числовую переменную.

Прим.:  Это поле принимает значения в диапазоне от -9 223 372 036 854 775 808 до
9 223 372 036 854 775 807 и до 15 десятичных разрядов.

• In the End of range field, enter a number or select a predefined number variable that is greater than
the value in the Beginning of range field.

Прим.:  Это поле принимает значения в диапазоне от -9 223 372 036 854 775 808 до
9 223 372 036 854 775 807 и до 15 десятичных разрядов.

• Введите количество цифр после запятой, установив флажок Указать количество десятичных
знаков.

• In the Save the outcome to a variable field, select a predefined Number variable or create a new
one to hold the output.

To string action in Число
The To string action in the Число пакет enables you to convert a user-specified number to a string.
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Настройки

• In the Enter number field, enter a number or select a predefined Number variable.
• In the Enter number of digits after decimal field, enter the amount of digits after the decimal.

Чтобы удалить все цифры после десятичной запятой, оставьте значение по умолчанию равным 0.
• In the Assign the output to variable field, select a pre-defined String variable or create a new one to

hold the output. You can use prompt-assignment during building and testing of the бот.

Важное замечание:  Ensure that you reassign the values from prompt-assignment to a user-created
variable before deploying the бот into production.

Распознавание текста (OCR) пакет
The Распознавание текста (OCR) пакет contains actions that enable you to extract text from images
or applications.
The Распознавание текста (OCR) пакет enables you to:
• Extract text from a window or a specific area of an application.
• Extract text from images or files stored on a local machine, a website, or the Control Room folder.
• Filter extracted text and store it as a variable.

Прим.:  You can extract text from images in .jpeg, .jpg, .bmp, .gif, and .png formats.

ABBYY FineReader 12.2.27.12 is installed along with A2019 and does not require any additional setup.

Действия в Распознавание текста (OCR) пакет

пакет Распознавание текста (OCR) включает в себя указанные ниже actions.

Действие Описание

Получить
изображение по пути

См. раздел Using Capture image by path action.

Получить
изображение по
URL-адресу

См. раздел Using Capture image by URL action.

Захватить окно См. раздел Using Capture window action from Распознавание текста (OCR)
пакет.

Захватить область См. раздел Using Capture area action from Распознавание текста (OCR)
пакет.

Безопасная запись

Если включен режим безопасной записи, боты не отображают изображения целевых объектов после
съемки. Это гарантирует, что конфиденциальные данные не будут показаны.
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Прим.:  Несмотря на то, что боты не отображают целевые изображения после записи, изображения
все еще хранятся в памяти Control Room, потому что они необходимы для запуска боты.

Когда вы записываете задание в режиме безопасной записи, в окне Предварительный просмотр
временно отображается изображение захваченной области. Это изображение будет скрыто после
того, как вы переместитесь за пределы окна Bot editor или обновите его.
Этот параметр должен быть включен пользователем с полномочиями администратора. См. раздел
Настройки.
Ссылки, связанные с данной
Screen resolution dependent пакеты
The screen resolution between the Bot Runner and Bot Creator device should be consistent as when
resolution-dependent пакеты are used to build боты, any screen resolution difference between the Bot
Creator and Bot Runner device will impact the боты during runtime.

Using Capture image by path action
Use the Capture image by path action to extract text from an image on a device or a folder in the
Control Room. The extracted text can assigned as a variable.
Follow these steps to use the Capture image by path action:
1. In the Действия palette, double-click or drag the Capture image by path action from the

Распознавание текста (OCR) пакет.
2. In the Image path field, select an option:

• Control Room file: Uses a file that is available on the Control Room.
• Desktop file: Uses a file that is available on a device.
• Переменная. Uses a file variable to specify the file location.

3. Select the Filter the captured text check box to filter the captured text.
Specify the text to filter out in the Before and After fields. For example, if the extracted text is
Name: ABC Inc. Location:, to retrieve ABC Inc., you must specify Location: in the Before
field and Name: in the After field.

4. Select the Trim the captured text check box to trim the extra spaces.
5. Select the Load Profile check box and select an option to load the locale based on the ABBYY profile:

Прим.:  ABBYY FineReader 12.2.27.12 is installed along with A2019 and does not require any
additional setup.

• Control Room file: Uses a file that is available on the Control Room.
• Desktop file: Uses a file that is available on a device.
• Переменная. Uses a file variable to specify the file location.

6. In the Select locale list, select the language of the device.

Прим.:  Currently, only English, Japanese, and Russian locales are supported. If you have selected an
option from the Select locale list and the Load Profile option, the system considers the locale based
on the Load Profile selection.

7. In the Assign value to variable list, select a string variable.
8. Щелкните Сохранить.
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Using Capture image by URL action
Use the Capture image by url action to extract text from an online image. You can filter the extracted
text and assign it to a string variable.
Follow these steps to use the Capture image by url action:
1. In the Действия palette, double-click or drag the Capture image by url action from the

Распознавание текста (OCR) пакет.
2. In the Image url field, specify the URL.

Прим.:  A URL of an image on a shared drive or an FTP server is not supported.

3. Select the Filter the captured text check box to filter the captured text.
Specify the text to filter out in the Before and After fields. For example, if the extracted text is
Name: ABC Inc. Location:, to retrieve ABC Inc., you must specify Location: in the Before
field and Name: in the After field.

4. Select the Trim the captured text check box to trim the extra spaces.
5. Select the Load Profile check box and select an option to load the locale based on the ABBYY profile:

Прим.:  ABBYY FineReader 12.2.27.12 is installed along with A2019 and does not require any
additional setup.

• Control Room file: Uses a file that is available on the Control Room.
• Desktop file: Uses a file that is available on a device.
• Переменная. Uses a file variable to specify the file location.

6. In the Select locale list, select the language of the device.

Прим.:  Currently, only English, Japanese, and Russian locales are supported. If you have selected an
option from the Select locale list and the Load Profile option, the system considers the locale based
on the Load Profile selection.

7. In the Assign value to variable list, select a string variable.
8. Щелкните Сохранить.

Using Capture window action from Распознавание текста (OCR) пакет
Use the Capture window action to extract text from an application window. You can filter the extracted
text and assign it to a string variable.
Follow these steps to use the Capture window action:
1. In the Действия palette, double-click or drag the Capture window action from the

Распознавание текста (OCR) пакет.
2. In the Window title field, select an option:

• Окно: Captures a window on a desktop. In the Window title field, specify the application title.
• Переменная. Inserts an existing window variable. Click Variable tab to create a new string

variable.

Вставьте символ подстановочного знака (*) в поле Заголовок окна для поиска заголовков
окон, которые могут меняться. You can specify one or more wildcards (*) at the start, middle, or
end of the value.For example, to perform an operation on any window that has Microsoft in the
title, use a wildcard to indicate any string by adding it before or after the value: *Microsoft*. The 
first searches for the exact window title (Microsoft), and if it does not find a match, it searches for
windows with the term Microsoft anywhere in the title.
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Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

3. Необязательно: Select the Resize window option to specify the window dimensions.
This option delivers a more reliable бот. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the ботto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Прим.:  This option is available only for windows that can be resized. It is not available for the
Desktop or Taskbar options.

4. In the Wait before capturing the image (ms) field, specify the delay time.

Recommendation:  If you are capturing in a window that is accessed using Remote Desktop
Protocol (RDP), set a minimum delay time of 1000 milliseconds to give the window time to load.

5. Select the Filter the captured text check box to filter the captured text.
Specify the text to filter out in the Before and After fields. For example, if the extracted text is
Name: ABC Inc. Location:, to retrieve ABC Inc., you must specify Location: in the Before
field and Name: in the After field.

6. Select the Trim the captured text check box to trim the extra spaces.

© 2023 Automation Anywhere. All rights reserved.     1715



    Automation Anywhere - Сборка

7. Select the Load Profile check box and select an option to load the locale based on the ABBYY profile:

Прим.:  ABBYY FineReader 12.2.27.12 is installed along with A2019 and does not require any
additional setup.

• Control Room file: Uses a file that is available on the Control Room.
• Desktop file: Uses a file that is available on a device.
• Переменная. Uses a file variable to specify the file location.

8. In the Select locale list, select the language of the device.

Прим.:  Currently, only English, Japanese, and Russian locales are supported. If you have selected an
option from the Select locale list and the Load Profile option, the system considers the locale based
on the Load Profile selection.

9. In the Assign value to variable list, select a string variable.
10. Щелкните Сохранить.

Using Capture area action from Распознавание текста (OCR) пакет
Use the Capture area action to extract text from a specific area in an application window. You can filter
the extracted text and assign it as a variable.
Follow these steps to use the Capture area action:
1. In the Действия palette, double-click or drag the Capture area action from the Распознавание

текста (OCR) пакет.
2. In the Window title field, select an option:

• Окно: Captures a window on a desktop. In the Window title field, specify the application title.
• Переменная. Inserts an existing window variable.

Вставьте символ подстановочного знака (*) в поле Заголовок окна для поиска заголовков
окон, которые могут меняться. You can specify one or more wildcards (*) at the start, middle, or
end of the value.For example, to perform an operation on any window that has Microsoft in the
title, use a wildcard to indicate any string by adding it before or after the value: *Microsoft*. The 
first searches for the exact window title (Microsoft), and if it does not find a match, it searches for
windows with the term Microsoft anywhere in the title.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
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you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

3. Необязательно: Select the Resize window option to specify the window dimensions.
This option delivers a more reliable бот. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the ботto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Прим.:  This option is available only for windows that can be resized. It is not available for the
Desktop or Taskbar options.

4. Specify the X, Y, Width, and Height coordinates.
5. Click Capture region.

The бот captures text from the visible area of the screen even if the target area is below the visible
screen.

6. In the Wait before capturing the image (ms) field, specify the delay time.

Recommendation:  If you are capturing in a window that is accessed using Remote Desktop
Protocol (RDP), set a minimum delay time of 1000 milliseconds to give the window time to load.

7. Select the Filter the captured text check box to filter the captured text.
Specify the text to filter out in the Before and After fields. For example, if the extracted text is
Name: ABC Inc. Location:, to retrieve ABC Inc., you must specify Location: in the Before
field and Name: in the After field.

8. Select the Trim the captured text check box to trim the extra spaces.
9. Select the Load Profile check box and select an option to load the locale based on the ABBYY profile:

Прим.:  ABBYY FineReader 12.2.27.12 is installed along with A2019 and does not require any
additional setup.

• Control Room file: Uses a file that is available on the Control Room.
• Desktop file: Uses a file that is available on a device.
• Переменная. Uses a file variable to specify the file location.

10. In the Select locale list, select the language of the device.

Прим.:  Currently, only English, Japanese, and Russian locales are supported. If you have selected an
option from the Select locale list and the Load Profile option, the system considers the locale based
on the Load Profile selection.

11. In the Assign value to variable list, select a string variable.
12. Щелкните Сохранить.
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Office 365 Calendar пакет
The Office 365 Calendar пакет contains actions that enable you to automate meeting-related tasks in
Office 365 Calendar.

Перед началом работы

Perform the following actions within the Office 365 Calendar пакет as part of using the set of available
actions:
1. Use the Connect action to establish a connection to the Office 365 server.

См. раздел Using Connect action for Office 365 пакеты.

Прим.:  Office 365 пакеты do not currently support Multi-Factor Authentication or Single Sign-on.

2. Use a combination of actions available in this пакет to automate tasks.

Прим.:  To use actions from other Office 365 packages, establish a connection using the Connect
action from that пакет.

3. Используйте action Отключить, чтобы разорвать соединение.

Действия in the Office 365 Calendar пакет

The Office 365 Calendar пакет includes the following actions:

Прим.:  Some of the actions must be used within a Loop action to apply the action to each meeting in
the calendar. См. раздел Using Office 365 Calendar actions in a loop.

Действие Описание

Добавить вложение См. Add attachment action in Календарь Office 365

Добавить участников См. Add attendees action in Календарь Office 365

Отменить собрание См. Cancel meeting action in Календарь Office 365

Подключить Establishes a connection with the Office 365
server using your organization's client ID and
tenant ID, and user credentials.
См. раздел Using Connect action for Office 365
пакеты.

Создать собрание См. раздел Using the Create Meeting action.

Delete attendees См. Delete attendees action in Календарь Office
365

Удалить информацию о собрании См. Delete meeting information action in
Календарь Office 365
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Действие Описание

Отключить Terminates the connection with the Office 365
server. Enter the session name that you used in
the Connect action. Insert this action at the end
of automation sequences that use actions from
this Office 365 package. См. раздел Disconnect
action for Office 365 пакеты.

Получить доступные периоды для собрания См. раздел Using the Get available meeting slots
action.

Изменить собрание См. Modify meeting action in Календарь Office 365

Ответить на приглашение на собрание См. Respond to meeting action in Календарь Office
365

Add attachment action in Календарь Office 365
The Add attachment action in the Календарь Office 365 package enables you to add one or more
attachments to a meeting.

Настройки

Use this action within a Loop action to repeat this operation for each meeting in the calendar. See Цикл
пакет.
• Provide the session name that you used in the Connect action.
• Select the files to attach from the Control Room or your desktop, or insert a file variable. Separate each

file path with a comma.

Add attendees action in Календарь Office 365
The Add attendees action in the Календарь Office 365 package enables you to add one or more
attendees to a meeting and specifies whether attendance is optional or required.

Настройки

During run time, this  triggers an email notification to meeting attendees. Use this  within a Loop  to
repeat this operation for each meeting in the calendar. See Цикл пакет.
• Provide the session name that you used in the Connect .
• Enter the attendee emails into the Required or Optional fields. Separate each email with a comma.

Cancel meeting action in Календарь Office 365
The Cancel meeting action in the Календарь Office 365 package enables you to cancel the meeting.

Настройки

During run time, this  triggers an email notification to meeting attendees. Use this  within a Loop  to
repeat this operation for each meeting in the calendar. See Цикл пакет.
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Using Connect action for Office 365 пакеты
Use the Connect action to establish a connection with the Office 365 server using your organization's
(client ID and tenant ID) and user credentials. All of the fields in this action accept a credential from the
Credential Vault or a user-input value.

Прим.:
• The Connect action does not currently support Multi-Factor Authentication or Single Sign-on.
• The best practice is for a system administrator to perform the following steps.

1. Log in to the Azure portal using your Office 365 credentials.
2. Register your application with the Microsoft identity platform to obtain the client ID and tenant ID. See

Register your app.
3. Grant the required permissions for Microsoft Graph to the application. См. раздел Permissions for

application.
4. To add a client secret, you must first subscribe to Azure. See Subscribe to Azure.
5. Add a client secret. See Add a client secret.

For an example on how to setup and connect to the Office 365 OneDrive пакет, see Working with the Office
365 OneDrive package.
To establish a connection to the Office 365 server, follow these steps:
1. In the Действия palette, double-click or drag the Connect action from the пакет you want to use.
2. In the User session field, enter a name for this session.

Provide this session name in subsequent actions from this package.
3. In the Username and Password fields, enter your user credentials or insert them from the

Credential Vault.
4. In the Tenant ID field, enter the unique ID for your Office 365 subscription or insert it from the

Credential Vault.
5. In the Client ID field, enter the Office 365 client or insert it from the Credential Vault.
6. In the Client Secret Key field enter your access token or insert it from the Credential Vault.
7. Щелкните Сохранить.

Permissions for application
After registering the Office 365, you must grant certain permissions to the application. These permissions
are required to enable Office 365 packages to perform various operations.
To grant permissions to an application, see Add permissions.

Прим.:  You must be the co-owner of the application for which you are configuring permissions.

The following Delegated permissions for Microsoft Graph are required for Office 365 packages:

Common permissions

openid

offline_access

User.Read
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User.ReadBasic.All

One Drive

Files.ReadWrite.All

Sites.ReadWrite.All

Calendar

Calendars.Read

Calendars.Read.Shared

Calendars.ReadWrite

Эл. почта

Mail.Read

Mail.ReadWrite

MailboxSettings.Read

MailboxSettings.ReadWrite

Directory

Directory.AccessAsUser.All

Directory.ReadWriter.All

Apart from the above permissions, you can grant additional permissions based on your requirements. See,
Microsoft Graph permission reference.

Using the Create Meeting action
Use the Create Meeting action to specify a meeting agenda, attachments, attendees, duration, location,
recurrence, and title. During run time, this action sends an invitation email to meeting attendees.
This action uses two Datetime variables to set the meeting start and end. Define the values before you
start. The recurrence option also uses two Datetime variables to set the start and end. Подробнее см. в
разделе Your variables (user-defined).
To create a meeting, do the following:
1. Enter the session name that you used in the Connect action.
2. Enter the calendar name.

Это поле заполняется с учетом регистра букв.
The prepopulated value is Calendar; this is the default Office 365 setting.

3. Specify the meeting start date and time.
Select a DateTime variable from the drop-down list.

4. Specify the meeting end date and time.
Select a DateTime variable with a value that is the same or after the start time.

5. Необязательно: Mark the All day meeting option.
For an all day meeting, ensure that there is a one-day difference between the start and end dates.

6. Enter attendee email addresses, separated by commas.
7. Необязательно: Enter the following details:

• Attach a file from the Control Room, Desktop, or insert a File variable.
• Enter a meeting title.
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• Enter a meeting location.
• Enter an agenda.
• Set a reminder.
• Set a recurrence with the following options:

• Select the recurrence type: Daily, Weekly, Monthly, or Yearly.
• For Weekly recurrence, mark the days of the week on which the meeting takes place.
• For Monthly recurrence, either enter the numerical date or select a day.

For example, to schedule a meeting that takes place on the twenty-fifth day of the month
enter 25 in the Specific date field.

Прим.:  If you enter 31 in the Specific date field, for the months with less than 31 days,
the meeting will schedule for the last day of the month.

To schedule it for the last Monday of the month, select Last from the Occurrence drop-
down list and Monday from the Weekday drop-down list.

• For Yearly recurrence, either enter the numerical date and month or select a day and
month.
For example, to schedule a meeting that takes place on March 15, enter 15 in the Specific
Date field and March in the Month field. To schedule it for the second Friday in March,
select Second from the Occurrence drop-down list, select Friday from the Weekday
drop-down list, and March from the Month drop-down list.

• Enter the recurrence frequency.
• Specify the recurrence start by selecting a DateTime variable from the drop-down list.
• If the recurrence has an end date, select a DateTime variable from the drop-down list.

Delete attendees action in Календарь Office 365
The Delete attendees action in the Календарь Office 365 package enables you to delete attendees from
a meeting.

Настройки

During run time, this action triggers an email notification to meeting attendees. Use this  within a Loop  to
repeat this operation for each meeting in the calendar. See Цикл пакет.
• Provide the session name that you used in the Connect .
• Select an option to delete: meeting or attendees. To delete attendees, provide the email addresses

of the attendees, separated by commas.

Delete meeting information action in Календарь Office 365
The Delete meeting information action in the Календарь Office 365 package enables you to delete
information related to a meeting such as the title or location.

Настройки

Use this  within a Loop  to repeat this operation for each meeting in the calendar. See Цикл пакет.
• Provide the session name that you used in the Connect .
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• Select the meeting information to delete. The options are:
• Заголовок
• Место проведения
• Повестка
• Напоминание
• Повторение
• На весь день

Disconnect action for Office 365 пакеты
Use the Disconnect action from the specific Office 365 пакет to terminate the connection from the Office
365 application.

Настройки

Enter the user session that you provided in the Connect action.

Using the Get available meeting slots action
Use the Get available meeting slots action to retrieve available time slots for attendees in a specified
date and time range. This action supports scheduling across time zones.
This action considers a time slot as available if it is within an attendee's working hours and if the attendee
has not already accepted a meeting for that time. If an attendee tentatively responds or does not respond
to an invitation, this action considers them available.
To retrieve available time slots, perform the following steps:
1. Enter the session name that you used in the Connect action.
2. Enter the email addresses of the attendees, separated by commas.
3. Enter the duration of the meeting in minutes.
4. Specify the range start date and time by selecting a DateTime variable from the drop-down list.
5. Specify the range end date and time by select a DateTime variable with a value that is the same or

after the start time.
6. Необязательно: Select the Check for timeslots outside working hours option.
7. Select a Table variable from the drop-down list.
8. Щелкните Сохранить.

Modify meeting action in Календарь Office 365
The Modify meeting actionin the Календарь Office 365 package enables you to modify information for a
meeting.

Настройки

Use this  within a Loop  to repeat this operation for each meeting in the calendar. See Цикл пакет.

• Provide the session name that you used in the Connect .
• Modify any of the following:

• Meeting start or end date.
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• Convert the meeting to all day.
• Revise the meeting title.
• Revise the agenda.
• Update the location.
• Update the reminder.
• Update the recurrence, frequency, start date, and end date.

Respond to meeting action in Календарь Office 365
The Respond to meeting action in the Календарь Office 365 package enables you to respond to a
meeting as accepted, rejected, or tentative.

Настройки

You can also add a message to the response.
Use this  within a Loop  to repeat this operation for each meeting in the calendar. See Цикл пакет.

Using Office 365 Calendar actions in a loop
You must use certain Office 365 Calendar actions within a Loop action.
This action uses two Datetime variables to set the meeting start and end. Define the values before you
start. Подробнее см. в разделе Your variables (user-defined).
To use an Office 365 Calendar action within a loop, follow these steps:
1. Double-click or drag the Loop action from the Loop пакет in the Действия palette.
2. Select the For each meeting in calendar iterator.
3. Enter the session name that you used in the Connect action.
4. Enter the calendar name.

Это поле заполняется с учетом регистра букв.
The prepopulated value is Calendar; this is the default Office 365 setting.

5. Select whether to loop through All meetings in the calendar or only meetings with the specific title.
6. Specify the meeting start date and time.

Select a DateTime variable from the drop-down list.
7. Specify the meeting end date and time.

Select a DateTime variable with a value that is the same or after the start time.
8. Необязательно: Enter the location.
9. Необязательно: Enter the duration in minutes.
10. Необязательно: Mark the All day meeting option.

For an all day meeting, ensure that there is a one-day difference between the start and end dates.
11. Необязательно: Enter the meeting owner's email address.
12. Select or create a record variable to hold the output.

Office 365 Excel пакет
The Office 365 Excel пакет contains actions that enable you to automate tasks in the online version of
Microsoft Excel.
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Choosing the Excel пакет in Automation 360

Automation 360 includes пакеты to support three types of Microsoft Excel usage. For optimal results, use
the пакет that corresponds to the type of Excel that is available on the device you are running боты on.
• No Excel installed: If you do not have Microsoft Excel installed on the device on which you are

running боты to automate Excel-related processes, use the Базовый Excel пакет.
• Desktop Excel installed: If you have a desktop version of Microsoft Excel installed on your computer,

use the Расширенный Excel пакет in your боты.
• Online Office 365 Excel only: If you are using Microsoft Excel 365 on a web browser, use the Office

365 Excel пакет for automating tasks related to Excel.

Перед началом работы

1. Use the Connect action to establish a connection to the Office 365 server.
См. раздел Using Connect action for Office 365 пакеты.

Прим.:  Office 365 пакеты do not currently support Multi-Factor Authentication or Single Sign-on.

2. Use the Open action to select a workbook, or the Create action to create a new workbook. См.
раздел Workbook operations in Office 365 Excel.

3. Необязательно. If the workbook contains more than one worksheet, use the Activate sheet
action to specify which worksheet to use.

4. Use a combination of actions available in this пакет to automate tasks.

Прим.:  To use actions from other Office 365 packages, establish a connection using the Connect
action from that пакет.

5. Use the Close action to exit from the workbook.
6. Используйте action Отключить, чтобы разорвать соединение.

Действия в Office 365 Excel пакет
The actions in the Office 365 Excel пакет enable you to perform the following operations:

Операции Описание

Ячейка Perform operations related to cell and range
operations, such as append, delete, format, get
properties, and insert.
См. Cell operations in Office 365 Excel

Row and column Perform operations related to column and row
operations such as autofit, delete, and read.
См. раздел Column/Row operations in Office 365
Excel.
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Операции Описание

Таблица Perform operations related to the table
operations such as create, delete, filter, get
properties, rename, and sort. См. раздел Table
operations in Office 365 Excel.

Workbook Automate opening, closing, and creating a
workbook.
См. раздел Workbook operations in Office 365
Excel.

Worksheet Perform operations related to worksheet
operations, such as activate, delete, find, get
worksheet names, hide, retrieve worksheet
count, and show.
См. раздел Worksheet operations in Office 365
Excel.

Cell operations in Office 365 Excel
The Office 365 Excel package contains actions that you can use to automate tasks related to cell and
range operations, such as append, delete, format, get properties, and insert.
The Office 365 Excel package includes the following actions:

Действие Описание

Удалить ячейку См. раздел Delete cell action in Office 365 Excel.

Удалить диапазон См. раздел Delete range action in Office 365 Excel.

Формат ячейки См. раздел Using the Format cell action.

Получить ячейку См. раздел Get cell action in Office 365 Excel.

Получить цвет ячейки/текста См. раздел Using the Get cell/text color action.

Получить несколько ячеек См. раздел Get multiple cells action in Office 365 Excel.

Перейти к ячейке См. раздел Go to cell action in Office 365 Excel.

Вставить ячейку См. раздел Insert cell action in Office 365 Excel.

Вставить диапазон См. раздел Insert range action in Office 365 Excel.

Вставить ячейку См. раздел Paste cell action in Office 365 Excel.

Прочитать формат ячейки См. раздел Read cell format action in Office 365 Excel.

Прочитать формулу ячейки См. раздел Read cell formula action in Office 365 Excel.

Задать ячейку См. раздел Set cell action in Office 365 Excel.

Установить цвет ячейки См. раздел Set cell color action in Office 365 Excel.

Задать формулу ячейки См. раздел Set cell formula action in Office 365 Excel.

Delete cell action in Office 365 Excel
The Delete cell action in Office 365 Excel enables you to delete an active cell or a specific cell from the
current worksheet.
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Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Select either the active cell or a specific cell. If you select Specific cell, enter the cell location. For

example A1.
• From the delete options, select one of the following options:

• Shift cells left: Deletes the specified cell and shifts the cell one position to left.
• Shift cells up: Deletes the specified cell and shifts the cell one position up.
• Entire row: Deletes the entire row that contains the cell that you have specified to delete.
• Entire column: Deletes the entire column that contains the cell that you have specified to delete.

Delete range action in Office 365 Excel
The Delete range action in Office 365 Excel enables you to delete a specific range of cells.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Enter the cell range. Например, A1:B4. This deletes an area consisting of the first four rows by the

first two columns.
• Specify whether to shift the cells up or left.

• Shift cells up: Deletes the specified cells and shifts the cells up by the number of rows deleted.
• Shift cells left: Deletes the specified cells and shifts the cells left by the number of columns

deleted.

Using the Format cell action
Use the Format cell action to set the format of a cell or group of cells.
To format a cell or group of cells, do the following:
1. Double-click or drag the Format cell action.
2. Enter the name of the session used to open the workbook with the Open .
3. Select the Active cell, Specific cell, or Multiple cells option and provide cell location or cell range,

as necessary.
4. Mark the Font option to modify any of the following:

• Имя шрифта
• Font size (between 8 and 72)
• Bold or italicize
• Подчеркивание
• Font color (accepts color name or hex value). For a list of color names and corresponding hex

values, see Frequently used cell colors.

5. Mark the Alignment option, then use the drop-down lists to modify the vertical or horizontal
alignment.

6. Mark the wrap text option to expand the cell(s) vertically to show long strings of text.

© 2023 Automation Anywhere. All rights reserved.     1727



    Automation Anywhere - Сборка

7. Mark the Merge Type option to select the any of the following operations:
• Merge and center
• Merge across
• Merge cells
• Unmerge

8. Щелкните Сохранить.

Frequently used cell colors
Review the color names and their corresponding hex values you can use to set a cell color for a cell or text
within a cell in a worksheet. These are the most frequently used options for formatting worksheets.

Имя Шестнадцатеричный

Aqua #00FFFF

Black #000000

Blue #0000FF

Gray #808080

Green #008000

Fuchsia #FF00FF

Lime #00FF00

Maroon #800000

Navy #000080

Olive #808000

Purple #800080

Red #FF0000

Silver #C0C0C0

Teal #008080

White #FFFFFF

Yellow #FFFF00

Get cell action in Office 365 Excel
Use the Get cell action in Office 365 Excel to retrieve the value of a cell.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Select either an Active cell or Specific cell. If you select a specific cell, enter the cell location.
• Присвойте выходные данные строковой переменной. To perform mathematical operations, convert

the string to a number using the String > To number. См. раздел To number action.

Using the Get cell/text color action
Use the Get cell/text color action to get the color of the background or text in a cell. This action
retrieves the color of a cell as RGB values. For example, if the background or text in a cell is of red color,
the value retrieved is 255,0,0.
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To get the color of the background or text in a cell, do the following:
1. Double-click or drag the Get cell/text color action.
2. Enter the name of the session used to open the workbook with the Open .
3. Select the Active cell option to get the color from the current active cell or the Specific cell option

to get the color from the address of the cell you have specified.
4. Select the Cell color option to get the background color of the cell, the Text color option to get the

color of the text, or both.
5. Specify whether to retrieve the cell color by name or as an RGB value.
6. Select a variable from the Assign the output to variable list to assign the cell/text color to a List

variable.
7. Щелкните Сохранить.

If both cell and text colors are retrieved, the List variable contains the cell color at index 0 and text
color at index 1.

Get multiple cells action in Office 365 Excel
Use the Get multiple cells action in Office 365 Excel to retrieve the values of multiple cells within a
worksheet and assign the output to a variable.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Select either the Multiple cells or All cells option. If you select Multiple cells, enter the cell range.

For example, if you enter A1:D1,values of the first four cells in the top row are retrieved.
• Присвойте выходные данные строковой переменной. To convert the string to a number, use the

String > To number action. См. раздел To number action.

Go to cell action in Office 365 Excel
Use the Go to cell action in Office 365 Excel to move the cursor to a specific cell in the worksheet.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Select from the following cell options:

• Specific cell: Moves to the specified cell address.
• One cell to the left: Moves one cell left.
• One cell to the right: Moves one cell right.
• One cell above: Moves one cell up.
• One cell below: Moves one cell down.
• Beginning of the row: Moves to the first cell in the same row.
• End of the row: Moves to the last cell that contains data in the same row.
• Beginning of the column: Moves to the first cell in the same column.
• End of the column: Moves to the last cell that contains data in the same column.

Insert cell action in Office 365 Excel
Use the Insert cell action in Office 365 Excel to insert a value to an active cell or a specific cell in the
current worksheet without overwriting the existing value.
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Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Select either Active cell or Specific cell. If you select Specific cell, enter the cell location, for

example A1.
• After inserting the cell, you can perform these operations:

• Shift cell > Down: Shifts the existing values down by the specified number of rows.
• Shift cell > Right: Shifts the existing values right by the specified number of columns.

Insert range action in Office 365 Excel
Use the Insert range action in Office 365 Excel to insert a range in the current worksheet without
overwriting the existing value.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Enter the cell range, for example A1:B4. This inserts a range of cells consisting of the first four rows by

the first two columns.
• After inserting the cell, you can perform these operations:

• Shift cell > Down: Shifts the existing values down by the specified number of rows.
• Shift cell > Right: Shifts the existing values right by the specified number of columns.

Paste cell action in Office 365 Excel
Use the Paste cell action in Office 365 Excel to copy a value from a cell and paste it to a specified cell. If
there is a value in the destination cell, this action will overwrite the value.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Select either the Active cell or Specific cell option to specify the cell from which to copy the value. If

you have selected the Specific cell option, specify the address of the cell in the Cell name field.
• Enter the destination cell address to paste the value. Например, B3.

Read cell format action in Office 365 Excel
Use the Read cell format action to retrieve the format of an active or a specified cell (such as vertical or
horizontal alignment and wrap text) and assign the output to a string variable.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Select the Active cell or Specific cell option to specify the cell from which to read the format. If you

have selected the Specific cell option, specify the address of the cell in the Cell name field.
• Select a String variable to store the cell format from the Assign the output to variable list.

Read cell formula action in Office 365 Excel
Use the Read cell formula action to retrieve a formula from an active or a specific cell and assign the
output to a string variable. This action returns a blank value if the specified cell does not contain a formula.
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Настройки

• Enter the name of the session used to open the workbook with the Open .
• Select the Active cell or Specific cell option to specify the cell from which to read the formula. If you

have selected the Specific option, specify the address of the cell in the field.
• Select a string variable to store the name of the formula from the Assign the output to variable

list. В  отображается описательное имя переменной по умолчанию. If you create several output
variables, subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

Set cell action in Office 365 Excel
Use the Set cell action to set a value in an active or a specific cell of an Excel spreadsheet or a CSV file.
You can also use this action to set a formula.

Настройки

• Enter the name of the session used to open the workbook with the Open .
• Select the Active cell or Specific cell option to specify the cell in which to set the value. If you have

selected the Specific cell option, specify the address of the cell in the field.

Прим.:  You can enter a cell range in the Specific cell field to set a particular value in all the cells
of the range. For example, to set a value of 5 on all cells in the second row and from the first through
third column, enter A2:C2.

• Enter the value to set in the Cell value field.

Set cell color action in Office 365 Excel
Use the Set cell color action to set a color to the background or text of an active cell or a Specific cell in a
worksheet.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Select the Active cell, Specific cell, or Cell range option to specify the cell in which to set the color.

If you have selected the Specific cell option, specify the address of the cell in the Cell name field.
• Select the item to which you want to apply the color: Cell or Text within cell.
• Enter a cell color by name or code.

Use either the color name or the hex value. For a list of color names and corresponding hex values, see
Frequently used cell colors.

Set cell formula action in Office 365 Excel
The set cell formula action enables you to set the formula of a specified cell in a worksheet.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Select the Active cell, Specific cell, or Mutliple cell option to specify the cell in which to set the

formula. If you have selected the Specific cell option, specify the address of the cell in the Cell name
field. For the multiple cell option, specify a cell range.

• Enter the value to set in the Cell formula field, without an "=".
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Column/Row operations in Office 365 Excel
The Office 365 Excel package contains actions that you can use to automate tasks related to column and
row operations such as autofit, delete, insert, and read.
The Office 365 Excel package includes the following actions:

Действия Описание

Автоподгонка столбцов См. раздел Autofit columns action in Office 365
Excel.

Автоподгонка строк См. раздел Autofit rows action in Office 365 Excel.

Удалить строку/столбец См. раздел Using Delete action for rows or
columns.

Получить число строк См. раздел Get row count action in Office 365
Excel.

Вставить строку/столбец См. раздел Using Insert action for rows or columns.

Прочитать столбец См. раздел Read column action in Office 365 Excel.

Прочитать строку См. раздел Read row action in Office 365 Excel.

Autofit columns action in Office 365 Excel
Use the Autofit columns action in the Office 365 Excel пакет to adjust (automatically fit) the width of
columns in a worksheet in a specified session.

Настройки

Enter the name of the session used to open the workbook with the Open .
Autofit rows action in Office 365 Excel
Use the Autofit rows action in the Office 365 Excel пакет to adjust (automatically fit) the height of the
rows in a worksheet in a specified session.

Настройки

Enter the name of the session used to open the workbook with the Open .
Using Delete action for rows or columns
Use the Delete action to remove rows or columns from the current worksheet.
To delete rows or columns in a worksheet, do the following:
1. Double-click or drag Office 365 Excel > Delete.
2. Enter the name of the session used to open the workbook with the Open .
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3. Select one of the following:
• Операции со строками

a. Select the Delete Row(s) at option to delete all of the cells in a specific row. Specify the row
number to delete in the field. For example, to delete the tenth row in the worksheet, enter 10
in the field.

b. Select the Delete Row(s) by option to delete all of the cells in either:
• the row of the active cell.
• a specific range of cells. Specify the range to delete. For example, to delete the first five

rows, enter 1:5 in the field.

• Операции со столбцами
a. Select the Delete Column(s) at option to delete all of the cells in a specific column. Specify

the address of the column to delete in the field. For example, to delete column 'D' in the
worksheet, enter D in the field.

b. Select the Delete Columns(s) by option to delete all of the cells in either:
• the column of the active cell.
• a specific range of cells. Specify the range to delete. For example, to delete the first five

columns, enter A:E in the field.

4. Щелкните Сохранить.

Get row count action in Office 365 Excel
Use the Get row count action in the Office 365 Excel пакет to retrieve the number of rows that contain
data in a worksheet.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Assign the output value to a Number variable.

To convert the variable to a String variable, use the Number > To string action. Подробнее см. в
разделе To string action in Число.

Using Insert action for rows or columns
Use the Insert action to create rows or columns in the current worksheet.
To insert or delete rows or columns in a worksheet, do the following:
1. Double-click or drag Office 365 Excel > Insert.
2. Enter the name of the session used to open the workbook with the Open .
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3. Select one of the following:
• Операции со строками

a. Select the Insert Row(s) at option to insert a row and specify the location where to insert
the row in the field. For example, to insert a row of cells in the tenth row in the worksheet,
enter 10 in the field.

b. Select the Insert Row(s) by option to insert all of the cells in either:
• the row of the active cell.
• a specific range of cells. Specify the range where to insert the row. For example, to insert a

row of cells in the first five rows in the worksheet, enter 1:5 in the field.

• Операции со столбцами
a. Select the Insert Column(s) at option to insert a column and specify the location where

to insert the row in the field. For example, to insert a column of cells in column 'D' in the
worksheet, enter D in the field.

b. Select the Insert Columns(s) by option to insert all of the cells in either:
• the column of the active cell.
• a specific range of cells. Specify the range to insert the column. For example, to insert a

row of cells in the first five columns, enter A:E in the field.

4. Щелкните Сохранить.

Read column action in Office 365 Excel
Use the Read column action in the Office 365 Excel пакет to extract data from a column and store it in a
List variable.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Select the cell option as Active cell or Specific cell to specify the starting point.
• You can also select the Read full column option to extract data for the entire column.
• Assign the output value to a List variable.

Read row action in Office 365 Excel
Use the Read row action in the Office 365 Excel пакет to extract data from a row and store it in a variable.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Select the cell option as Active cell or Specific cell to specify the starting point.
• You can also select the Read full row option to extract data for the entire row.
• Assign the output to a variable: Multiple variables or a Record variable.

Table operations in Office 365 Excel
The Office 365 Excel package contains various actions that you can use to automate tasks related to the
table operations such as create, delete, filter, get properties, rename, and sort.
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The Office 365 Excel package includes the following actions:

Действия Описание

Создать таблицу См. раздел Create table action in Office 365 Excel.

Удалить таблицу См. раздел Delete table action in Office 365 Excel.

Получить столбец таблицы См. раздел Get table column action in Office 365
Excel.

Получить имена таблиц См. раздел Get table names action in Office 365
Excel.

Получить строку таблицы См. раздел Get table row action in Office 365
Excel.

Получить число строк в таблице См. раздел Get table row count action in Office 365
Excel.

Переименовать таблицу См. раздел Rename table action in Office 365
Excel.

Create table action in Office 365 Excel
The Create table action in the Office 365 Excel пакет enables you to create a new table in the specified
table range.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Enter the table name.
• Enter the cell range in which to create the table. For example, A1:D4.
• Необязательно. Select the Table has headers option to establish the first row as the header row.

Delete table action in Office 365 Excel
The Delete table action in the Office 365 Excel пакет enables you to delete a table in the active worksheet.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Enter the table name that has to be deleted.

Get table column action in Office 365 Excel
Use the Get table column action in the Office 365 Excel пакет to retrieve the column values of a specified
table and column index, and assign the values to a List variable.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Enter the table name.
• Enter the column index. For example, enter 5 to indicate the fifth column from the left.
• Select a List variable to store the values.
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Get table names action in Office 365 Excel
The Get table names action in Office 365 Excel enables you to retrieve the names of all the tables in a
workbook and assign them to a List variable.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Необязательно. Select whether to specify a sheet either by index or name.
• Select a List variable to store the values.

Get table row action in Office 365 Excel
The Get table row action in Office 365 Excel enables you to retrieve the row values of a specified table and
row index, and assign the values to a variable.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Enter the table name.
• Enter the row index. For example, enter 5 to indicate the fifth row from the top.
• Assign the output to a variable: Multiple variables or a Record variable.

Get table row count action in Office 365 Excel
The Get table row count action in Office 365 Excel enables you to retrieve the row count of a specified
table and assign the values to a number variable.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Enter the table name.
• Select a Number type variable to store the values.

To convert the variable to a String variable, use the Number > To string action. For more information,
see To string action in Число .

Rename table action in Office 365 Excel
The Rename table action in Office 365 Excel enables you to rename a table.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Enter the current or existing table name.
• Enter a new table name.

Workbook operations in Office 365 Excel
The Office 365 Excel package contains enables you to automate opening, closing, or creating a new
workbook.
The Office 365 Excel package includes the following actions:
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Действия Описание

Закрыть See Close action.

Создать книгу See Create workbook action.

Открыть См. раздел Using the Open action.

Close action in Office 365 Excel
Use the Close action in Office 365 Excel пакет to close a workbook.

Настройки

Enter the name of the session used to open the workbook with the Open .
Create workbook action in Office 365 Excel
Use the Create workbook action in Office 365 Excel пакет when you want to create a new workbook.

Настройки

• Enter Enter the name of the session used to open the workbook with the Open .
• Provide a File Path containing the new workbook name with one of the following

extensions: .xls, .xlsm, .xlsx.
Either enter the file path or select a String variable. For example, to perform this action on a file named
SalesReport.xlxs, located in the Accounts folder, enter Accounts/SalesReport.xlxs.

Using the Open action
Use this action to open a workbook. Insert this action at the start of your automation sequences.
To open a workbook, do the following:
1. Double-click or drag the Open action.
2. Provide the username either by selecting a Credential variable or entering an unencrypted value.
3. Enter a Session name.

Use this same session name in subsequent actions to associate them with this workbook.
4. Enter the File Path or insert a file variable.

For example, to perform this action on a file named SalesReport.xlxs, located in the Accounts
folder, enter the file name SalesReport.xlxs.

Прим.:  Ensure that the Microsoft Excel file is placed in the My Files folder in OneDrive.

5. If the sheet contains a header row, mark the Sheet contains header option.
6. Щелкните Сохранить.

Worksheet operations in Office 365 Excel
The Office 365 Excel package contains actions that you can use to automate tasks related to worksheet
operations, such as delete, find, get worksheet names, hide, retrieve worksheet count, and show.
The Office 365 Excel package includes the following actions:

Действия Описание

Копировать лист См. раздел Using the Copy worksheet action.
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Действия Описание

Создать лист См. раздел Create sheet action in Office 365 Excel.

Удалить лист См. раздел Delete worksheet action in Office 365
Excel.

Получить имя текущего листа См. раздел Get current worksheet name action in
Office 365 Excel.

Получить имена листов См. раздел Get worksheet names action in Office
365 Excel.

Скрыть лист См. раздел Hide worksheet action in Office 365
Excel.

Переименовать лист См. раздел Rename worksheet action in Office 365
Excel.

Получить число листов См. раздел Retrieve sheet count action in Office 365
Excel.

Показать лист См. раздел Show worksheet action in Office 365
Excel.

Переключиться на лист См. раздел Switch to sheet action in Office 365
Excel.

Using the Copy worksheet action
Use the Copy worksheet action to copy values of a worksheet from one worksheet to another. This
action overwrites any existing values. To move values from one worksheet to another without overwriting
existing values, use the Append worksheet action.
Open the workbook(s) containing the source and target worksheets. См. раздел Using the Open action.

Прим.:  This action identifies the destination and source workbooks by the session names used to open
them. If opening two workbooks, enter a session name for the source workbook that is different than the
one used to open the destination workbook.

To copy the values of a worksheet into another, do the following:
1. Double-click or drag the Copy worksheet action.
2. Enter the name of the session that you used to open the destination workbook in the Open action.
3. If the workbook contains more than one worksheet, mark the Specific Sheet option, then enter the

index number or name of the source worksheet.
• The index number represents the position of the worksheet in the workbook. For example, to

perform an operation on the worksheet at the third position in the workbook, enter 3 in the field.
• The sheet name field is case insensitive.

4. Enter the name of the session that you used to open the source workbook in the Open action.
5. If the workbook contains more than one worksheet, mark the Specific Sheet option, then enter the

index number or name of the destination worksheet.
6. Щелкните Сохранить.

Create sheet action in Office 365 Excel
The Create sheet action in the Office 365 Excel package enables you to add an empty sheet in the
current workbook.
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Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Enter a Worksheet name of up to 31 characters. The name cannot contain the following characters:

\ / ? * [ ]

Delete worksheet action in Office 365 Excel
The Delete worksheet action in the Office 365 Excel package enables you to delete a spreadsheet from
the current workbook.

Настройки

• Enter the name of the session used to open the workbook with the Open .
• Укажите для листа номер индекса в поле Лист по индексу или имя в поле Лист по имени. The

index number is the number assigned to a worksheet. For example, if you want to perform an operation
on the worksheet at the third position in the workbook, enter 3 in the field.

Прим.:  Вы можете удалить лист, только если книга содержит более одного листа.

Get current worksheet name action in Office 365 Excel
The Get current worksheet name action in the Office 365 Excel package enables you to retrieve the
name of the currently active worksheet.

Настройки

• Enter the name of the session used to open the workbook with the Open .
• Select a string variable that you want to use to store the name of the worksheet from the Assign the

output to variable list. В  отображается описательное имя переменной по умолчанию. If you
create several output variables, subsequent variable names are appended with a -1, -2, -3, and so on
to avoid duplication.

Get worksheet names action in Office 365 Excel
The Get worksheet names action in the Office 365 Excel package enables you to retrieve the names of
all the worksheets in the workbook.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Select a list variable to store the worksheet names from the Assign the output to variable list.

Hide worksheet action in Office 365 Excel
The Hide worksheet action in the Office 365 Excel package enables you to hide a worksheet from the
current workbook.
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Настройки

• Укажите имя листа, который требуется скрыть в поле Введите имя листа, который требуется
скрыть.

Прим.:  Вы можете скрыть лист, только если книга содержит более одного листа.

• Enter the name of the session used to open the workbook with the Open .

Rename worksheet action in Office 365 Excel
The Rename worksheet action in the Office 365 Excel package enables you to rename a worksheet in
the current workbook.

Настройки

• Укажите номер индекса или имя листа, который нужно переименовать в поле Лист по индексу
или Лист по имени.
Номер индекса — это номер, присвоенный листу. Например, если вы хотите выполнить операцию
на листе, находящимся на третьей позиции в книге, введите в поле значение 3.

Прим.:  Вы не можете переименовать лист, если лист с таким же именем уже существует в
книге.

• Введите новое имя листа, содержащее менее 31 символа.
• Enter the name of the session used to open the workbook with the Open .

Retrieve sheet count action in Office 365 Excel
The Retrieve sheet count action in the Office 365 Excel package enables you to get the number of
sheets available in the current workbook and stores it in a number variable.

Настройки

• Выберите соответствующий параметр, чтобы указать, включать ли скрытый лист или нет, и
присвоить число переменной.

• Enter the name of the session used to open the workbook with the Open .
• Select a number variable that you want to use to store the name of the worksheet from the Select the

variable to assign to list. В  отображается описательное имя переменной по умолчанию. If you
create several output variables, subsequent variable names are appended with a -1, -2, -3, and so on
to avoid duplication.

Show worksheet action in Office 365 Excel
The Show worksheet action in the Office 365 Excel package enables you to show the hidden worksheet.

Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Enter the Worksheet name.

Switch to sheet action in Office 365 Excel
The Switch to sheet action in the Office 365 Excel package enables you to activate a particular sheet in a
Microsoft Excel file.
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Настройки

• Enter the name of the session used to open the workbook with the Open action.
• Укажите, следует ли активировать Лист по индексу (числовое значение) или Лист по имени.

Office 365 One Drive пакет
The One Drive пакет contains actions that enable you to automate many of the repetitive tasks in
Microsoft cloud storage.

How to use the actions in the One Drive пакет

Perform the following actions within the One Drive пакет as part of using the set of available actions:
1. Use the Connect action to establish a connection to the Office 365 server.

См. раздел Using Connect action for Office 365 пакеты.

Прим.:  Office 365 пакеты do not currently support Multi-Factor Authentication or Single Sign-on.

2. Use a combination of actions available in this пакет to automate tasks.

Прим.:  To use actions from other Office 365 packages, establish a connection using the Connect
action from that пакет.

3. Используйте action Отключить, чтобы разорвать соединение.

For an example on how to setup and connect to the Office 365 OneDrive пакет, see Working with the Office
365 OneDrive package.

Действия in the One Drive пакет
Use the actions in the One Drive пакет to perform an operation on a single file or folder. To perform the
operation on every file in a folder, use that action in a loop. См. раздел Using One Drive actions in a loop.

Прим.:  Automation 360 supports the shared drive. To use shared drive items such as a file or folder, you
should provide the link and name of that file or folder.

The One Drive пакет includes the following actions:

Действие Описание

Проверить разрешения Check permission action

Подключить Establishes a connection with the Office 365
server using your organization's client ID and
tenant ID, and user credentials.
См. раздел Using Connect action for Office 365
пакеты.

Копировать файл или папку Copy file or folder action
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Действие Описание

Создать папку Create folder action

Удалить файл или папку Delete file or folder action

Отключить Disconnect action for Office 365 пакеты

Загрузить файл Download file action

Экспортировать как PDF Export to PDF action

Найти файлы и папки Find files and folders action

Получить сведения о файле или папке Get file or folder information action

Переместить файл или папку Move file or folder action

Переименовать файл или папку Rename file or folder action

Восстановить последнюю версию Restore last version action

Отправить файл Upload file action

Using One Drive actions in a loop
Use the Find files and folder action to return a table of files and their properties inside of a specified
folder, the Loop action to loop through each row in the table, and a One Drive action to perform an
operation on every file in the table.
To perform an action on every file in a folder, do the following steps:
1. Double-click or drag One Drive > Find files and folders.
2. Provide your username with either a credential variable or an unencrypted value.
3. Enter the file path of the folder in which to perform the search.
4. Select the All items in folder option.

You can alternatively select Specific file (or folder) to limit the search to a specific folder on your
OneDrive.

5. Выберите или создайте переменную таблицы для сохранения выходного значения.
The table variable holds information on files and folders in rows, under the following columns: name,
id, createdBy, creationDate, lastModifiedBy, lastModificationDateTime, parentFolder, and Path.

6. Дважды щелкните или перетащите action Цикл.
7. Select the For each row in table iterator.
8. Select the table variable holding the output from step 5.
9. Select or create a record variable to temporarily hold each row.
Insert the action inside of the Loop container that you want to repeat on every file in the folder. This
example uses the Download file action.
10. Double-click or drag Outlook > Download file.
11. Provide your username with either a credential variable or an unencrypted value.
12. Enter the following in the File name including path field, replacing the generic variable names with

the names of the record variables from step 10:
$RecordVariable[7]$/$RecordVariable[0]$
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13. Enter the path to the folder where to download the files.
14. Щелкните Сохранить.

Check permission action
The Check permission action in the Office 365 OneDrive пакет checks for read and write permission for a
file or folder in your OneDrive.

Настройки

• Enter the Office 365 user session that you provided in the Connect action.
• Provide the file or folder name for which to check permissions.
• Specify which permission type to verify: Read or Read & Write.
• Select a predefined Boolean type variable to hold the output, or click the icon on the right to create a

new variable.
The Boolean type variable will provide a true (user has permission) or false (user does not have
permission) response.

Copy file or folder action
The Copy file or folder action in the Office 365 OneDrive пакет duplicates a file or folder from one folder to
another in your OneDrive.

Настройки

• Enter the user session that you provided in the Connect .
• Select whether to copy a file or folder.
• Provide the source and destination file/folder names and paths or file/folder link.

To obtain the file or folder link, copy the link generated from Share OneDrive files and folders

For example, to perform this action on a file named SalesReport.xlxs, located in the Accounts folder,
enter /Accounts/SalesReport.xlxs.

Прим.:  The forward slash that indicates that a file or folder is located in the root directory is optional.

• Необязательно. If there is file or folder with the same name in the destination folder, select the
Override existing file/folder option which replaces the existing file or folder with the one being
copied.

Create folder action
The Create folder action in the Office 365 OneDrive пакет creates a new folder in a specific directory in
your OneDrive.

Настройки

• Enter the user session that you provided in the Connect .
• Enter the parent folder name and path, or folder link.

To obtain the folder link, copy the link generated from Share OneDrive files and folders
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For example, to perform this action on a folder named Q1, located in the Survey Results folder, enter /
Survey Results/Q1.

• Введите новое имя папки.

Delete file or folder action
The Delete file or folder action in the Office 365 OneDrive пакет removes a file or folder from a specific
directory in your OneDrive.

Настройки

• Enter the user session that you provided in the Connect .
• Select whether to delete a file or folder.
• Provide the name and path, or file or folder link.

To obtain the file or folder link, copy the link generated from
For example, to perform this  on a file named SalesReport.xlxs, located in the Accounts folder, enter /
Accounts/SalesReport.xlxs.

Прим.:  The forward slash that indicates that a file or folder is located in the root directory is optional.

Download file action
The Download file action in the Office 365 OneDrive пакет downloads a file from a specific directory in
your OneDrive.

Настройки

• Enter the user session that you provided in the Connect .
• Provide the file name and path, or file link.

To obtain the file link, copy the link generated from Share OneDrive files and folders

For example, to perform this  on a file named SalesReport.xlxs, located in the Accounts folder, enter /
Accounts/SalesReport.xlxs.

Прим.:  The forward slash that indicates that a file or folder is located in the root directory is optional.

• Enter the destination folder path on the local device.
• Необязательно. If there is file or folder with the same name in the destination folder, select the

Override existing file/folder option which replaces the existing file or folder with the one being
copied.

Export to PDF action
The Export to PDF action in the Office 365 OneDrive пакет exports an existing file in your OneDrive to a
PDF on your device. This action supports the following file extensions: doc, docx, oentry, odp, pps, ppt,
pptx, tf, xls, and xlsx.

Настройки

• Enter the user session that you provided in the Connect .
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• Provide the file name and path, or file link. Either enter the values or insert a predefined string variable.
To obtain the file link, copy the link generated from Share OneDrive files and folders

For example, to perform this  on a file named SalesReport.xlxs, located in the Accounts folder, enter /
Accounts/SalesReport.xlxs.

Прим.:  The forward slash that indicates that a file or folder is located in the root directory is optional.

• Enter the export folder name and path or select a predefined string variable.
• Необязательно. If there is file or folder with the same name in the destination folder, select the

Override existing file/folder option which replaces the existing file or folder with the one being
copied.

Find files and folders action
The Find files and folders action in the Office 365 OneDrive пакет returns a table of files and folders in a
specific directory in your OneDrive.

Настройки

• Enter the user session that you provided in the Connect .
• Provide directory details in the Folder to search field: enter the folder name and path, or folder link.

To obtain the folder link, copy the link generated from
For example, to perform this  on a folder named Q1, located in the Survey Results folder, enter /
Survey Results/Q1.

• Specify whether to search for All items in folder or a Specific file (or folder).

Прим.:  The Drive Item Name field accepts wildcard characters in the file name and extension.
For example, to search for all documents with extension docx, enter *.docx in the Specific file (or
folder) field.

• Assign the output to a table variable.
The variable will hold the following file or folder details: Name, ID, CreatedBy, CreationDate,
LastModifiedBy, LastModificationDate, and ParentFolderPath.

Get file or folder information action
The Get file or folder information action in the Office 365 OneDrive пакет retrieves information for a
specific file or folder from OneDrive.

Настройки

• Enter the user session that you provided in the Connect .
• Provide the file or folder name and path, or file/folder link.

To obtain the file or folder link, copy the link generated from
For example, to perform this  on a file named SalesReport.xlxs, located in the Accounts folder, enter /
Accounts/SalesReport.xlxs.

Прим.:  The forward slash that indicates that a file or folder is located in the root directory is optional.

© 2023 Automation Anywhere. All rights reserved.     1745

https://support.office.com/en-us/article/share-onedrive-files-and-folders-9fcc2f7d-de0c-4cec-93b0-a82024800c07


    Automation Anywhere - Сборка

• Assign the output to a record variable.
The variable will hold the following file or folder details: Name, ID, CreatedBy, CreationDate,
LastModifiedBy, LastModificationDate, and ParentFolderPath.

Move file or folder action
The Move file or folder action in the Office 365 OneDrive пакет moves a file or folder from one folder to
another in OneDrive.

Настройки

• Enter the user session that you provided in the Connect .
• Select whether to move a file or folder.
• Provide the source and destination file or folder names and paths, or file/folder links.

To obtain the file or folder link, copy the link generated from
For example, to perform this  on a file named SalesReport.xlxs, located in the Accounts folder, enter /
Accounts/SalesReport.xlxs.

Прим.:  The forward slash that indicates that a file or folder is located in the root directory is optional.

• Необязательно. If there is file or folder with the same name in the destination folder, select the
Override existing file/folder option which replaces the existing file or folder with the one being
copied.

Rename file or folder action
The Rename file or folder action in the Office 365 OneDrive пакет renames a file or folder in a specific
directory in OneDrive.

Настройки

• Enter the user session that you provided in the Connect .
• Select whether to rename a file or folder.
• Provide the current and new file or folder names, or file/folder link.
• To obtain the file or folder link, copy the link generated from
• Необязательно. If there is file or folder with the same name in the destination folder, select the

Override existing file/folder option which replaces the existing file or folder with the one being
copied.

Restore last version action
The Restore last version action in the Office 365 OneDrive пакет restores a file to the last version.

Настройки

• Enter the user session that you provided in the Connect .
• Provide the file name and path, or file link.

To obtain the file or folder link, copy the link generated from
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For example, to perform this  on a file named SalesReport.xlxs, located in the Accounts folder, enter /
Accounts/SalesReport.xlxs.

Прим.:  The forward slash that indicates that a file or folder is located in the root directory is optional.

Upload file action
The Upload file action in the Office 365 OneDrive пакет uploads a file to a specific directory in OneDrive.

Настройки

• Enter the user session that you provided in the Connect .
• Provide the file name and path on the local directory.

For example, D:/Mydata/HR/EmployeeSurvey.xlsx.
• Provide the upload folder name and path, or folder link.

To obtain the folder link, copy the link generated from
For example, to perform this action on a folder named Q1, located in the Survey Results folder in home
directory, enter /Survey Results/Q1

Прим.:  You cannot provide the private folder path from one drive as it is not supported.

• Необязательно. If there is file or folder with the same name in the destination folder, select the
Override existing file/folder option which replaces the existing file or folder with the one being
copied.

PDF пакет
Use the PDF пакет to automate various operations on a PDF file.
The PDF пакет enables you to perform the following tasks:
• Encrypt or decrypt a PDF file.
• Extract text from a PDF file.
• Convert a PDF file to an image.
• Merge several PDF files into a single file.
• Split a single PDF file into multiple files.

It is not necessary to have a PDF reader installed on your device.

Действия в PDF пакет

пакет PDF включает в себя указанные ниже actions.

Прим.:  The Extract field, Extract image, and Extract text actions in the PDF пакет are supported only for
PDF files that are editable. These пакеты are not supported for scanned PDF documents that contain the
PDF content as images.

Действие Описание

Расшифровать
документ

См. раздел Using the Decrypt document action.
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Действие Описание

Зашифровать
документ

См. раздел Using the Encrypt document action.

Извлечь поле См. Using the Extract field action

Извлечь изображение См. раздел Using the Extract image action.

Извлечь текст См. раздел Using Extract text action from PDF.

Получить свойство См. Using the Get property action

Объединить
документы

См. раздел Using the Merge documents action.

Разделить документ См. раздел Using the Split document action.

When an operation is performed on a PDF file, the file properties are stored in a dictionary variable. См.
раздел Using a dictionary variable for PDF properties.

Using the Encrypt document action
Use the Encrypt document action to encrypt a PDF file.
To encrypt a PDF file, follow these steps:
1. In the Действия palette, double-click or drag the Encrypt document action from the PDF пакет.
2. In the PDF path, select one of the following options to specify the location of the PDF:

• Файл Control Room. Enables you to select a PDF file that is available in a folder in the Control
Room.

• Профиль рабочего стола. Enables you to select a PDF file that is available on your device.
• Переменная. Enables you to specify the file variable that contains the location of the PDF file.

3. Необязательно: In the User password or Owner password field, enter a password to restrict
access to the encrypted PDF file.
• User password: Allow users to perform specific operations on the encrypted PDF file.
• Owner password: Allow users to use a password to open the file.

4. In the User Permissions to Apply field, select the following operations:
• Print: Allows users to print the document.
• Modify: Allows users to edit the document.
• Copy: Allows users to copy the document.
• Form Fill: Allows users to fill a form in the document.
• Document Assembly: Allows users to combine multiple PDF files, attach files, and so on.
• Annotation: Allows users to apply annotations in the document.
• Accessibility: Allows users to read text from the document using accessibility devices.

5. In the Encryption level, select the RC4 40-bit, RC4 128-bit, or AES 128-bit option to specify the
encryption level.

6. In the Save encrypted PDF as field, specify a name and location for the encrypted file.
You must include the .pdf extension in the name of the encrypted file. For example, if the file name is
June_Quarter_report, the .pdf extension is June_Quarter_report.pdf.
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7. Select the Overwrite files with the same name check box to overwrite existing files with the same
name.

Прим.:  If this option is not selected and the бот encounters a file with the same name at the
specified location, the бот will fail.

8. Необязательно: From the Assign PDF properties to a dictionary variable list, select a dictionary
variable to hold the file properties.
Подробнее см. в разделе Using a dictionary variable for PDF properties.

9. Щелкните Сохранить.

Задачи, связанные с данной
Using the Decrypt document action
Use the Decrypt document action to decrypt a PDF file that was previously encrypted using the Encrypt
document action.

Using the Extract field action
Use the Extract field action to extract fields from a PDF and assign it to variables.

Важное замечание:  When you extract fields from a PDF that contains 20 form fields, processing time
might be 30 to 40 % longer than PDFs without form fields.

To extract fields from a PDF file, follow these steps:
1. In the Действия palette, double-click or drag the Extract field action from the PDF пакет.
2. In the PDF path, select one of the following options to specify the location of the PDF:

• Файл Control Room. Enables you to select a PDF file that is available in a folder in the Control
Room.

• Профиль рабочего стола. Enables you to select a PDF file that is available on your device.
• Переменная. Enables you to specify the file variable that contains the location of the PDF file.

3. From the File is protected field, select Yes if the file is encrypted and provide the User password
or Owner password.

4. Click Open PDF viewer.
5. In the Select a PDF file window, select a PDF file from Control Room file or Desktop file.
6. Необязательно: Enter the password.
7. Click Load to open the PDF Viewer.

In the PDF Viewer window, the PDF is opened with all the structured fields highlighted in purple
dotted rectangles.

8. Select the rectangular area of the field to be extracted and click Add field to add the field and its
value under the Extract fields table.

9. Необязательно: You can add an unstructured field that are not highlighted in the PDF. Select the
Draw a region option available at the top of the PDF viewer and draw a rectangle box around the
required region.
A red colored dotted rectangle is highlighted with an option Add custom region

10. Click Add custom region to view the captured coordinates in the Custom region window. Enter the
Key name that can be used in the output variable.

11. Click Close to add the field in the Extract fields table.
The list of extracted fields appear under the Extract fields table on the right panel of PDF viewer
window.
The extracted fields change to blue dotted rectangles in the PDF viewer. You can edit the extracted
fields by selecting the blue rectangle around the field.
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Use the vertical ellipse button next to the extracted field in the Extract fields table to Edit, Move or
Delete the field.

12. Click Close to close the PDF viewer .
13. From the Save the output to a variable field, choose either a dictionary variable or multiple

variables to hold the field values.
14. Щелкните Сохранить.

Using Extract text action from PDF
Извлекайте текст из PDF-файла и сохраняйте его в текстовом файле, используя action Извлечь
текст.

Важное замечание:  Если правильные шрифты не встроены в файл PDF, то action Извлечь текст
не сможет извлечь текст должным образом.

Прим.:  When you extract fields from a PDF that contains 20 form fields, processing time might be 30 to
40 % longer than PDFs without form fields.

Чтобы извлечь текст из файла PDF, выполните следующие действия.
1. На палитре Действия дважды щелкните или перетащите action Извлечь текст из пакет PDF.
2. In the PDF path, select one of the following options to specify the location of the PDF:

• Файл Control Room. Enables you to select a PDF file that is available in a folder in the Control
Room.

• Профиль рабочего стола. Enables you to select a PDF file that is available on your device.
• Переменная. Enables you to specify the file variable that contains the location of the PDF file.

3. Необязательно: In the User password or Owner password field, enter a password to restrict
access to the encrypted PDF file.
• User password: Allow users to perform specific operations on the encrypted PDF file.
• Owner password: Allow users to use a password to open the file.

4. В поле Тип текста выберите один из следующих параметров.
• Обычный текст. Извлечение текста и его копирование в текстовый файл.

Работает аналогично копированию и вставке текста из файла PDF в текстовый файл.
• Структурированный текст. Сохранение оригинального форматирования текста,

извлеченного из файла PDF.
Вы можете выбрать параметр Уменьшить потерю данных, чтобы обеспечить извлечение
полного текста с минимальным перекрытием символов. Благодаря этой функции
уменьшается количество символов, перекрываемых другими символами.

Прим.:  При выборе этого параметра для извлечения текста извлеченный текст может
содержать лишние символы пробела.

5. In the Page range field, select one of the following options:
• All pages: Enables you to save all the pages in the PDF file as an image.
• Pages: Enables you to enter the page numbers of the pages that you want to save as an image.
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6. В поле Экспорт данных в текстовый файл укажите имя и местоположение текстового
файла.

Прим.:  Необходимо включить расширение .txt в имя текстового файла. Например, если имя
файла June_Quarter_report, то с расширением .txt имя будет June_Quarter_report.txt.

7. Select the Overwrite files with the same name check box to overwrite existing files with the same
name.

Прим.:  If this option is not selected and the бот encounters a file with the same name at the
specified location, the бот will fail.

8. Необязательно: From the Assign PDF properties to a dictionary variable list, select a dictionary
variable to hold the file properties.
Подробнее см. в разделе Using a dictionary variable for PDF properties.

9. Щелкните Сохранить.

Using the Extract image action
Use the Using Extract image action to save a PDF file as an image.
To save a PDF file as an image, follow these steps:
1. In the Действия palette, double-click or drag the Extract image action from the PDF пакет.
2. In the PDF path, select one of the following options to specify the location of the PDF:

• Файл Control Room. Enables you to select a PDF file that is available in a folder in the Control
Room.

• Профиль рабочего стола. Enables you to select a PDF file that is available on your device.
• Переменная. Enables you to specify the file variable that contains the location of the PDF file.

3. Необязательно: In the User password or Owner password field, enter a password to restrict
access to the encrypted PDF file.
• User password: Allow users to perform specific operations on the encrypted PDF file.
• Owner password: Allow users to use a password to open the file.

4. In the Page range field, select one of the following options:
• All pages: Enables you to save all the pages in the PDF file as an image.
• Pages: Enables you to enter the page numbers of the pages that you want to save as an image.

5. In the Type of image to be converted to list, select one of the following options to specify the
format:
• TIFF: If you selected this option, select an option from the TIFF compression type list.

• NONE
• LZE
• RLE
• CCITT Group 3
• CCITT Group 4

• BMP
• JPEG: If you selected this option, in the JPEG quality field, enter a value (between 0 and 100) to

specify the quality of the compressed image.
• GIF
• PNG
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• WMF
• EMF
• EXIF

6. In the Folder path field, specify the location.
7. In the File prefix field, enter a value.

The image files are suffixed with index numbers. For example, if you have specified Report as the
File prefix, the name of the image files will be Report_1, Report_2, and so on.

8. Select the Overwrite files with the same name check box to overwrite existing files with the same
name.

Прим.:  If this option is not selected and the бот encounters a file with the same name at the
specified location, the бот will fail.

9. In the X Resolution (dpi) and Y Resolution (dpi) fields, specify the resolution.
10. In the Image output field, choose Color or Grayscale to specify the image output type:

a) In the Color property list, select an option.
• True color (32 bits)
• True color (24 bits)
• High color (16 bits)
• 56 color (8 bits)
• 16 color (4 bits)
• 2 color (1 bit, black/white)

Прим.:  This option is available only with the Color image output type. Select this option only
if RLE, CCITT Group 3, or CCITT Group 4 compression type is selected for the TIFF image
format.

11. Необязательно: From the Assign PDF properties to a dictionary variable list, select a dictionary
variable to hold the file properties.
Подробнее см. в разделе Using a dictionary variable for PDF properties.

12. Щелкните Сохранить.

Using the Decrypt document action
Use the Decrypt document action to decrypt a PDF file that was previously encrypted using the Encrypt
document action.
To decrypt an encrypted PDF file, follow these steps:
1. In the Действия palette, double-click or drag the Decrypt document action from the PDF пакет.
2. In the PDF path, select one of the following options to specify the location of the PDF:

• Файл Control Room. Enables you to select a PDF file that is available in a folder in the Control
Room.

• Профиль рабочего стола. Enables you to select a PDF file that is available on your device.
• Переменная. Enables you to specify the file variable that contains the location of the PDF file.

3. Необязательно: In the User/Owner password field, enter a password to restrict access to the
decrypted PDF file.
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4. In the Save the decrypted PDF file as field, specify a name and location for the decrypted file.
You must include the .pdf extension in the name of the decrypted file. For example, if the file name is
June_Quarter_report, the .pdf extension is June_Quarter_report.pdf.

5. Select the Overwrite files with the same name check box to overwrite existing files with the same
name.

Прим.:  If this option is not selected and the бот encounters a file with the same name at the
specified location, the бот will fail.

6. Необязательно: From the Assign PDF properties to a dictionary variable list, select a dictionary
variable to hold the file properties.
Подробнее см. в разделе Using a dictionary variable for PDF properties.

7. Щелкните Сохранить.

Задачи, связанные с данной
Using the Encrypt document action
Use the Encrypt document action to encrypt a PDF file.

Using the Get property action
Use the Get property action to obtain the properties of the PDF document.
1. In the Действия palette, double-click or drag the Get property action from the PDF пакет.
2. In the PDF path, select one of the following options to specify the location of the PDF:

• Файл Control Room. Enables you to select a PDF file that is available in a folder in the Control
Room.

• Профиль рабочего стола. Enables you to select a PDF file that is available on your device.
• Переменная. Enables you to specify the file variable that contains the location of the PDF file.

3. From the File is protected field, select Yes if the file is encrypted and provide the User password
or Owner password.

4. From the Assign PDF properties to a dictionary variable field, choose either a dictionary variable
or multiple variables to hold the field values.
To assign the output to a dictionary variable, map the PDF properties such as File, Author, Title, and
Subject to the corresponding dictionary keys.

5. Щелкните Сохранить.

Using the Merge documents action
Use the Merge documents action to merge multiple PDF files into a single PDF file.
1. In the Действия palette, double-click or drag the Merge documents action from the PDF пакет.
2. Click Add PDF document to provide details on the first PDF file.

The Add PDF document window appears.
3. In the PDF path, select one of the following options to specify the location of the PDF:

• Файл Control Room. Enables you to select a PDF file that is available in a folder in the Control
Room.

• Профиль рабочего стола. Enables you to select a PDF file that is available on your device.
• Переменная. Enables you to specify the file variable that contains the location of the PDF file.

4. Необязательно: In the User password or Owner password field, enter a password to restrict
access to the encrypted PDF file.
• User password: Allow users to perform specific operations on the encrypted PDF file.
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• Owner password: Allow users to use a password to open the file.

5. In the Page range field, select one of the following options:
• All pages: Selects all the pages in the PDF file.
• Pages: Enter the page numbers of the pages that you want to merge.

Прим.:  If you entered 1-3,5-7,8,10 or 10,8,5-7,1-3 in Enterprise 11, the output was
pages 1,2,3,5,6,7,8,10. In Automation 360, if you enter the input as follows:
• In ascending order 1-3,5-7,8,10, the output of the pages is 1,2,3,5,6,7,8,10
• In descending order 10,8,5-7,1-3, the output of pages is 10,8,5,6,7,1,2,3

6. Click Yes, Add.
7. Repeat Steps 2 through 6 to provide details on additional PDF files.

To modify the details of, or delete a PDF file, open the actions menu (the vertical ellipsis to the right of
the file).

8. Place the files in the order that they should appear in the merged file.
To move a file, open the actions menu. Then use the Move up or Move down options.

9. In the Output file path field, specify a name and location for the merged file.
You must include the .pdf extension in the name of the decrypted file. For example, if the file name is
June_Quarter_report, the .pdf extension is June_Quarter_report.pdf.

10. Select the Overwrite files with the same name check box to overwrite existing files with the same
name.

Прим.:  If this option is not selected and the бот encounters a file with the same name at the
specified location, the бот will fail.

11. Щелкните Сохранить.

Using the Split document action
Use the Split document action to split a PDF file into multiple files.
To split a PDF file into multiple files, follow these steps:
1. In the Действия palette, double-click or drag the Split document action from the PDF пакет.
2. In the PDF path, select one of the following options to specify the location of the PDF:

• Файл Control Room. Enables you to select a PDF file that is available in a folder in the Control
Room.

• Профиль рабочего стола. Enables you to select a PDF file that is available on your device.
• Переменная. Enables you to specify the file variable that contains the location of the PDF file.

3. Необязательно: In the User password or Owner password field, enter a password to restrict
access to the encrypted PDF file.
• User password: Allow users to perform specific operations on the encrypted PDF file.
• Owner password: Allow users to use a password to open the file.
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4. In the Output file creation options, select one of the following options to specify how to split the
PDF file:
• Number of pages per extracted PDF: Enables you to specify the number of pages each new

file will contain. For example, you can enter 8 if you want each output file to contain only 8 pages.
• Single file with selected pages: Enables you to create a single output file that contains the

pages you have specified from the original file.
• Blank page as a separator: Creates a new output file whenever a blank page is encountered in

the original PDF file.
PDF split separates a blank page from pages with scanned images.

• Bookmark level per file: Enables you to split the PDF file according to the bookmark level
available in the file. For example, if a file contains three bookmark levels, you can split the PDF file
based on these three levels.
If you selected this option, specify the bookmark level in the Bookmark Level field.

5. In the Folder path field, specify the location.
6. In the File prefix field, enter a value.

The image files are suffixed with index numbers. For example, if you have specified Report as the
File prefix, the name of the image files will be Report_1, Report_2, and so on.

7. Select the Overwrite files with the same name check box to overwrite existing files with the same
name.

Прим.:  If this option is not selected and the бот encounters a file with the same name at the
specified location, the бот will fail.

8. Необязательно: From the Assign PDF properties to a dictionary variable list, select a dictionary
variable to hold the file properties.
Подробнее см. в разделе Using a dictionary variable for PDF properties.

9. Щелкните Сохранить.

Using a dictionary variable for PDF properties
When you automate a PDF-related task, Рабочая область RPA retrieves various properties of the file and
stores the values of these properties in a dictionary variable.
Рабочая область RPA retrieves the PDF file name and extension, title, subject, and author. The file
properties are stored in a dictionary variable within the following keys:
• pdfTitle
• pdfFilename
• pdfSubject
• pdfAuthor

The system automatically associates the properties of a PDF with the appropriate dictionary keys.
For example, if you create a dictionary variable Test and want to log the file name and author, you must
enter Test{pdfFilename} and Test{pdfAuthor} in the appropriate fields.

PGP пакет
Use the PGP (Pretty Good Privacy) пакет to automatically encrypt and decrypt files for security.
The PGP пакет supports two types of encryption, symmetric (single key) and asymmetric (pair of keys) :
• PGP symmetric : Requires a single key to encrypt and decrypt files.
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• PGP asymmetric: Requires PGP public and private key to encrypt and decrypt files.

Прим.:  The system outputs an error when the proper file extension is not present in the path.
• Public key: File name specified for Public Key is not valid.
• Private key: File name specified for Private Key is not valid.

Действия в PGP пакет

пакет PGP включает в себя указанные ниже actions.

Действие Описание

Создать ключи См. раздел Create keys action in PGP.

Расшифровать файлы Decrypts encrypted files. См. Using the Decrypt files action

Зашифровать файлы Encrypts files to enable users to send them over the internet securely. См.
Using the Encrypt files action

Create keys action in PGP
Use the Create keys action in the PGP пакет to create a pair of public and private encryption keys.

Настройки

• In the Location to save public key file field, specify the path to the text file where to save the public
key.

• In the Location to save private key file field, specify the path to the text file where to save the
private key.

• In the Password to protect private key file field, select a credential variable or enter a value.
• Select the Overwrite files with the same file name check box to replace files with the same name.

Using the Decrypt files action
Use the Decrypt files action to retrieve the contents of encrypted files and folders.
To decrypt a file or folder, do the following steps:
1. Double-click or drag the Decrypt action from the PGP пакет.
2. Select either the Passphrase or Public key file encryption type.

• If you have selected Passphrase, enter the value or select a credential variable.
• If you have selected Private key file, provide the private key file path.

Необязательно. In the Password to protect private key file field, select a credential variable
or enter a value.

3. In the Source folder/file(s) field, specify the folders or files to decrypt.
This field supports wildcard characters in the file name and extension. Use an asterisk (*) to substitute
for one or more unknown alphanumeric characters or symbols.

4. In the Destination folder/file(s) field, specify the location where to save the decrypted folders and
files.
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This field supports wildcard characters in the file name and extension. Use an asterisk (*) to substitute
for one or more unknown alphanumeric characters or symbols.

5. Select the Overwrite Files option to replace files with the same name.
6. Select the Remove file extension option and specify the extension name.
7. Щелкните Сохранить.

Using the Encrypt files action
Use the Encrypt files action to prepare files and folders to be shared securely.
To encrypt the files or folder using a public key, create a public-private key pair using the Create keys
action.
To encrypt a file or folder, do the following steps:
1. Double-click or drag the Encrypt action from the PGP пакет.
2. Select either the Passphrase or Public key file encryption type.

• If you have selected Passphrase, enter the value or select a credential variable.
• If you have selected Public key file, provide the public key file path.

3. Select the Encryption algorithm.
Выберите из указанных ниже вариантов.
• AES128
• AES192
• AES256
• Blowfish
• CAST5
• Idea
• TripleDES
• TwoFish256

4. In the Source folder/file(s) field, specify the folders or files to encrypt.
This field supports wildcard characters in the file name and extension. Use an asterisk (*) to substitute
for one or more unknown alphanumeric characters or symbols.
Пример.
• Enter C:\PGP\encrypt*.csv to select the .csv files that start with the word encrypt.
• Enter C:\PGP\*encrypt*.* to select files of any extension that contain the word encrypt.

5. In the Destination folder/file(s) field, specify the location where to save the encrypted folders and
files.
This field supports wildcard characters in the file name and extension. Use an asterisk (*) to substitute
for one or more unknown alphanumeric characters or symbols.

6. Enter a value to append to the extension of the destination file.
7. Select the Overwrite Files check box to replace files with the same name.
8. Select the Compression type.

Выберите из указанных ниже вариантов.
• Нет
• zip
• bzip2
• zlib
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9. Select the Armor data (text output) check box to enable ASCII Armor output.
10. Щелкните Сохранить.

Play Sound package
The Воспроизвести звук пакет contains actions that enable you to play a beep sound and media file
before or after an action is executed in a бот.
The Воспроизвести звук пакет includes the following actions:

Действие Описание

Воспроизвести гудок См. раздел Play beep action.

Воспроизвести
медиафайл

См. раздел Play media file action.

Play beep action
The Play beep action enables you to play a beep sound before or after an action is executed.

Play media file action
The Play media file action enables you to play an audio file before or after an action is executed.

Настройки

From the Select a file to play field, select one of the following tabs to specify the location of the media
file:
• Control Room file: Use a file that is available on the Control Room.
• Desktop file: Use a file that is available on a device.
• Переменная. Use a variable to specify the file location.

Прим.:  Only .wav and .mp3 files are supported and do not require any media player installed on the
device.

Принтер пакет
Use the actions in the Принтер пакет to automate retrieving and setting the default printer and removing
a printer from the list of available printers.

Действия в Принтер пакет

пакет Принтер включает в себя описанные ниже actions.

Действие Описание

Get Default См. раздел Get default action.

Удалить См. раздел Remove action.

Set Default См. раздел Set default action.
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Get default action
The Get default action enables you to retrieve the default printer and assign a value to a string variable.

Настройки

• Click the Select the destination string variableChoose a variable drop-down menu to select a
variable.

• (Optional) Click Create variable icon if you do not have an existing variable.

Remove action
The Remove action enables you to delete or remove a printer.

Настройки

• Click the Enter the printer name drop-down menu to view a list of available printers, and select a
printer that you want to remove.

• (Optional) If the available printers are not listed, click the Refresh options icon.

Set default action
The Set default action enables you to set a default printer.

Настройки

• Click the Enter the printer name drop-down menu to view a list of available printers, and select a
printer that you want to set as the default one.

• (Optional) If the available printers are not listed, click the Refresh options icon.

Process пакет
The Process пакет contains a request action that enables the Control Room user to use this action and
configure their боты.

Перед началом работы

Прим.:  The Process пакет is now renamed to the AARI on the web пакет in Enterprise A2019.18 with
the Create a Request action and additional new actions. См. раздел AARI Web пакет.

Ensure you have met one of the following conditions in order to run this package:

Условие 1 • Доступ к процессу в назначенной группе.
• Access to AARI User license.
• Созданная системой функция

AAE_Robotic_Interface User для
пользователя AARI.
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Условие 2 • Доступ к лицензии Bot Runner (с
сопровождением или без сопровождения) или
лицензии Bot Creator.

• Созданная пользователем роль с
разрешениями Просмотреть моих ботов и
Запустить моих ботов.

Действия in the Process пакет

The Process пакет includes the following action:

Действие Описание

Создать запрос Создает запрос.
• In the Select Process field, select or upload your process.
• Specify your variable in the Dictionary or Variable field.

• Словарь. Input your variable information in the Type, Key, and
Value fields.
In the Type field, you can choose between Any, String, Number,
Datetime, or Boolean.

• Необязательно. In the Add field, add more dictionary variables.
• Переменная. Введите пользовательскую переменную.

• Необязательно. In the Assign the Request ID to field, assign a
variable to store as an output.
The output is stored as an ID value.

Запрос пакет
Use the Запрос пакет to accept an input value, a yes/no response, or to open a file or folder.

Действия в Запрос пакет

пакет Запрос включает в себя указанные ниже actions.

Действие Описание

Для файла См. раздел For file action in Запрос.

Для папки См. раздел For folder action in Запрос.

Для значения См. раздел For value action in Запрос.

Запрос «Да/нет» См. раздел For yes/no action in Запрос.

Ссылки, связанные с данной
Message box package
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Use the Message box action from the Message box package to insert a message box that shows a
message when the task runs. For example, you can insert a Message Box action to follow a web form so
that the action displays the message: Web Form Filled and Complete.

For file action in Запрос
The For file action in the Prompt пакет prompts you to select a single or multiple files on bot execution.

Настройки

• In the Prompt window caption field, enter a window caption.
• In the Prompt message field, enter a message.
• In the Assign the value to a variable field, specify a list variable.

For folder action in Запрос
The For folder action in the Prompt пакет prompts you to choose a folder.

Настройки

• In the Prompt window caption field, enter a window caption.
• In the Prompt message field, enter a message.
• In the Assign the value to a variable field, specify a variable.

For value action in Запрос
The For value action in the Prompt пакет prompts you to enter a value.

Настройки

• In the Prompt window caption field, enter a window caption.
• In the Prompt message field, enter a message.
• In the Assign the value to a variable field, specify a variable.

For yes/no action in Запрос
The For yes/no action in the Prompt пакет prompts you to choose a Yes/No response.

Настройки

• In the Prompt window caption field, enter a window caption.
• In the Prompt message field, enter a message.
• In the Assign the value to a variable field, specify a variable.

Python Script пакет
The Python Script пакет contains actions that enable Python Script functions in a task.
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Перед началом работы

Ensure the following requirements are met before using the Python Script пакет:
• The appropriate version of Python is installed on the device on which you want to execute the script.

Прим.:  Python versions 2.x and 3.x are supported.

• The "PATH" environment variable is updated to the path of the Python folder.
To verify if the Python environment variable is set correctly, enter Python in the command prompt. If it
returns the Python version that is installed, the path environment is set up correctly.

Выполните указанные ниже actions в рамках пакет Python Script из числа доступных actions.
1. Open a Python Script file, or manually enter the script you want to run using the Open action. You

must associate the details of the file or script you want to run with a session name.
2. Run the script using the Execute function or the Execute script action. You must use the same

Python Script session name established in the Open action.
3. Close the Python Script session after running the script.

Прим.:  When you run a бот that contains Python Script actions, the script runs in the background.
To review the бот launcher logs, navigate to C:\ProgramData\AutomationAnywhere\BotRunner
\Logs\<current month>\Bot_Launcher-<today's date>.log.zip. Each zipped folder contains
a file with data on the code execution, which is useful for debugging.

Действия в Python Script пакет

пакет Python Script включает в себя указанные ниже actions.

Прим.:  The Open action must be the first action to use the Python Script in a task. These actions can
run a Python Script on Windows, Linux, and UNIX-based devices.

Действие Описание

Закрыть См. раздел Close action.

Выполнить функцию См. раздел Execute function action.
For an example, see Example of using Python script to join a list.

Выполнить сценарий См. раздел Execute script action.
For an example, see Create a PDF using Python script.

Открыть См. раздел Open action.
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More resources

• Free боты that use Python from Bot Store
• Python Excel demo
• Speech to text using Python
• Run Python script

• Developer content on automating with Python: Automate with Python integration

Close action
The Close action in the Python Script пакет closes the session.

Настройки

Specify the same session name from the Open action.

Важное замечание:  It is mandatory to close the session after the script is executed.

Execute function action
The Execute function action in the Python Script пакет enables you to execute a function within the Python
Script package.

Настройки

• In the Python session field, specify a session name. Use the same session name from the Open
action.

• Необязательно. Укажите имя функции для выполнения и аргументы, которые нужно передать
функции.
This field supports Boolean, dictionary, list, number, or string variables.

Прим.:  The interface allows you to select only one argument. Use a list variable to concatenate
multiple arguments into one variable.

• Необязательно. In the Assign the output to variable field, specify the string variable.

Execute script action
The Execute script action in the Python Script пакет enables you to execute a script within the Python
Script package.

Настройки

• In the Python session field, specify a session name. Use the same session name from the Open
action.

• Необязательно. In the Assign the output to variable field, specify the string variable.
If the бот executes the script successfully, this action returns the string True. Otherwise an error
message appears.
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Open action
The Open action in the Python Script пакет opens the session.

Настройки

• In the Python session field, specify a session name. Use this same session name for other Python
Script actions.

• In the Python field, choose one of the following options:
• In the Import existing file option, select an existing Python Script file.

Прим.:  If you are uploading a script from a file on your desktop, the file and any dependencies
must be in a standalone folder. When you select a file for upload, all files and folders at the same
folder level are uploaded.

• In the Manual input option, enter the Python Script.

• In the Python runtime version field, select 2 or 3 to specify the runtime version.

Прим.:  Select the runtime version based on the version of Python installed on the device.

Create a PDF using Python script
Build a бот that runs Python script from a file and generates a PDF.
• To run Python script from Automation 360, you must already have the latest version of Python 3.x

installed on your device.
• This example uses the FPDF library to generate the PDF. Therefore, install it before you start building

this бот by copying and pasting the following line in the Windows command prompt:

pip install fpdf

См. раздел FPDF project page.

1. Create a file in a standalone folder to hold the following Python script:
Insert your device username in the angle brackets.

from fpdf import FPDF
pdf = FPDF()
pdf.add_page()
pdf.set_font("Arial", size=12)
pdf.cell(200, 10, txt="Go Be Great!", ln=1, align="C")
pdf.output("C:/Users/<yourusername>/Desktop/sample_demo.pdf")

Прим.:  If you are uploading a script from a file on your desktop, the file and any dependencies must
be in a standalone folder. When you select a file for upload, all files and folders at the same folder
level are uploaded.

2. Create a new бот:
a) На левой панели щелкните Автоматизация.
b) Щелкните Создать > Бот.
c) In the Create Task Bot window, enter the бот name.
d) Accept the default folder location: \Bots\
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To change the default бот storage location, click Choose and follow the prompts.
e) Щелкните Создать и редактировать.

3. Provide the script with a Python Script > Open action:
a) Double-click or drag the Python Script > Open.
b) Select the Import existing file option.
c) Click Browse to select the .py file you created in Step 1.

4. Use a Python Script > Execute script action to tell the бот to run the script:
a) Double-click or drag Python Script > Execute script.

5. Close the script execution session with a Python Script > Close action:
a) Double-click or drag Python Script > Close.
b) Щелкните Сохранить.

6. Click the Run icon.
The бот creates a PDF on the desktop with the text Go Be Great!.
To review the бот launcher logs, navigate to C:\ProgramData\AutomationAnywhere
\BotRunner\Logs\<current month>\Bot_Launcher-<today's date>.log.zip. Each
zipped folder contains a file with data on the code execution, which is useful for debugging.
If the бот does not create a file, change the last line in the Python script:

pdf.output(r"C:/Users/<yourusername>/Desktop/sample_demo.pdf")

Record пакет
The Record пакет contains actions that enable you to perform various operations on record-type
variables.

Действие in the Record пакет

The Record пакет includes the following action:

Присвоить См. раздел Assign action in Record.

Assign action in Record
The Assign action in the Record пакет enables you to assign the value of the source record variable to
the destination record variable.

Настройки

• In the Select the source record variable field, select the source record variable from the drop-down
list or create a new record variable.

• In the Select the destination record variable field, select a destination record variable or create
one to hold the output.
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• Record: Use this option to store the output in a record-type variable.
• Несколько переменных. Use this option to store the output in multiple variables by providing

the key and the variable to which the key is mapped. This variable can be of any type, such as
String, Number, Datetime, Boolean and so on. For example, if your source record variable
contains two entries; name and contact number, you can store the output as given below:

Ключ Привязать к переменной

Имя StrName

Contact number MobileNo

The variables StrName and MobileNo are String and Number type variables respectively.

Пакет Средство записи
Средство записи пакет захватывает серию задач в ходе их выполнения, а затем автоматизирует
их. Вы можете автоматизировать работу своих бизнес-приложений (например, настольных и
веб-приложений, приложений SAP и Java) с помощью функции Средство записи для записи
actions, выполняемых с объектами приложений, например с текстовым полем, кнопкой, таблицей,
переключателем, комбинированным полем и представлением списка.

Automation 360 extension setting

If the бот execution takes longer when you use the Средство записи to automate a static page running
on the Google Chrome or Microsoft Edge browser, then follow these steps to enable the setting in the
Automation 360 extension:
• Click the extensions icon at the top right corner of the browser window.
• Click the vertical ellipses next to the Automation 360 plugin and select Manage extension.
• Enable the Allow access to file URLs option.
• Restart the browser and run the бот.

Benefits of using Средство записи пакет instead of SAP пакет

We recommend that you use the Средство записи to automate SAP applications. When you use the
Средство записи to automate SAP applications, you have the following benefits:
• You can automate objects without creating a session. When you use the SAP пакет you must create a

session.
• You can automate the object directly without generating the field paths or having any prior knowledge

of the field paths. When you use the SAP пакет, the пакет will execute actions directly on control field
paths when properties in the search criteria match the object that the бот searches during execution.

• If the Средство записи runtime window overlaps the object that you want to automate, then the
Средство записи hides the runtime window before you automate the object.

• Средство записи supports actions in the Если, Цикл, and Ожидать пакеты that enables you to check
if an object exists in the specific browser or window.

Прим.:  When compared to the Средство записи пакет, the SAP пакет enables you to automate an
application without activating the application window.
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action «Запись»

Используйте action Запись для записи взаимодействия с объектом пользовательского интерфейса
(UI). Это action позволяет добавить одно взаимодействие при создании бот.

Прим.:
• Запись action заменяет команду Object Cloning из Version 11.3.
• If you open a window in any of the supported browsers with a user account that is different from the

one used to log in to the computer, the Средство записи might not capture and play the control actions
accurately.

Using the Capture action

Вы можете делать снимки объектов и автоматизировать объекты внутри междоменного IFrame,
который содержит несколько элементов IFrame с одним и тем же источником кадров, а также
элементы IFrame, которые динамически загружаются во время выполнения в браузерах Google
Chrome и Microsoft Edge на базе Chromium. После записи объекта внутри междоменного IFrame путь
к кадру по умолчанию сохраняется в свойстве FrameDOMXPath.
You can automate the following applications running on Microsoft Edge Chromium with IE mode:
• Java web applications
• Applications that are accessed through the Citrix Workspace app.
• Citrix Virtual Apps

Новый FrameDOMXPath определяет кадр, в котором находится объект. Это свойство необходимо
выбрать, чтобы запустить бот для успешной автоматизации объектов на междоменном IFrame.

Прим.:  Если вы удалите свойство FrameDOMPath из критериев поиска, при определении кадра
произойдет сбой Средство записи.

Important:  В браузере Google Chrome можно записывать и автоматизировать объекты между
несколькими доменами и использовать несколько кадров с одним источником.

Теперь при автоматизации веб-страницы в Google Chrome и Microsoft Edge на базе Chromium или
в Mozilla Firefox можно захватывать всплывающие окна, диалоговые окна с предупреждениями,
диалоговые окна с подтверждением и диалоговые окна с запросами, которые появляются.

Recommendations:
• Если вам нужно автоматизировать диалоговое окно предупреждения на веб-странице,

рекомендуется добавить задержку перед использованием action Средство записи > Запись,
поскольку иногда диалоговое окно предупреждения появляется с задержкой в окне приложения.

• Для точной записи или автоматизации объектов в приложениях SAP рекомендуется включить
поддержку сценариев. Если поддержка сценариев не включена, под окном выполнения бот
отображается следующее сообщение запроса.
Сценарии SAP отключены.Включите сценарии для более надежной записи

Если вы не включите поддержку сценариев, то вместо использования технологии SAP Средство
записи использует технологию MSAA для записи объектов.
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Automate applications running as an admin user

You can capture objects on applications that are running as an administrator by selecting the Capture
and run with admin privileges option from the Bot editor.

Before you automate applications running as an admin user, ensure the following:
• Bot Agent is installed in system profile.
• Bot Creator and Bot Runner have admin rights on the device to automate the applications.

When you select the Start recording option in the Bot editor to record multiple applications, and switch
applications running in elevated and non-elevated mode, the бот might not be able to identify the change
between modes. In such cases, for all captures on applications in elevated mode, select the Capture and
run with admin privileges option and then re-capture the object.

Прим.:  Elevated mode gives you permission to run applications as an administrator.

Важное замечание:  When you try to automate any Java or SAP application that is non-elevated by
using the Средство записи in elevated mode, the бот encounters an error.
To avoid this error, de-select the Capture and run with admin privileges option from the Bot editor
and run the Средство записи in non-elevated mode to capture Java or SAP applications.

Свойства объекта

Когда вы выбираете объект для записи, Universal Recorder собирает данные о свойствах объекта,
чтобы идентифицировать объект во время выполнения. Со свойствами объекта можно выполнить
следующие действия.
• Убедитесь, что свойства записанного объекта соответствуют предполагаемому объекту.

Например, при записи таблицы с веб-сайта, убедитесь в том, что Тип элемента управления и
Тег HTML имеют значения ТАБЛИЦА.

• Извлеките значение свойства. Используйте action Получить свойство и введите имя свойства
в поле Имя свойства или выберите свойство объекта из списка доступных. The list includes
suggested property values from the search criteria in the Object Properties table. To select an object
property from the list of properties, move the mouse pointer to the right of the Property name field
and click the arrow.
Например, чтобы получить текст ссылки, используйте action Получить свойство и введите HTML
 InnerText в поле Имя свойства или выберите HTML InnerText из списка свойств.

• Вы можете выбрать комбинацию свойств для бот для поиска уникального объекта в окне
бизнес-приложения.

Алгоритм поиска для пакет Средство записи гарантирует, что при запуске бот объект будет записан
только в том случае, если его свойства соответствуют точному критерию поиска, который был
выбран в таблице Свойства объекта. Если свойства объекта не точно соответствуют критерию
поиска, то работа бот завершится с сообщением об ошибке. Однако, если критерий поиска включает
символ подстановки, то бот запишет первый объект, соответствующий критерию.
Например, чтобы захватить текстовое поле из приложения, которое имеет три текстовых поля
с именами firstname1, firstname2 и firstname3, если параметр Имя HTML был выбран в
качестве критерия поиска, введите значение firstname в поле имени HTML и запустите бот, после
чего работа бот завершится с сообщением об ошибке, поскольку текстовое поле с именем HTML
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firstname не существует. Однако если в поле Имя HTML ввести firstname* и запустить бот, то
бот запишет первое текстовое поле, соответствующее критерию.

Прим.:  Эта функция доступна для ботов, создаваемых с помощью пакет Средство записи версии
2.4.0-20211016-070100, начиная с Automation 360 версии 23. Если вы создали боты с помощью
предыдущей версии пакет Средство записи, для использования этой функции потребуется создать
объекты повторно.

Действия, выполняемые с записанными объектами

После записи объекта укажите действие, которое должен совершить с объектом бот во время
выполнения. Например, если вы записали гиперссылку, вы можете выбрать действие, чтобы
щелкнуть по ссылке или извлечь текст ссылки. Чтобы посмотреть таблицу всех объектов и
возможных действий, см. Actions performed on objects captured with Universal Recorder.

Прим.:  Если вы столкнулись с ошибкой при выполнении бот, который выполняет запись объектов
из Internet Explorer, а сообщение об ошибке связано с Google Chrome, см. Your Chrome Plug-in is either
not installed or disabled (A-People login required.

Фоновая обработка

Background processing enables an automation that involves interacting with an application in the
foreground (such as mouse clicks) to run in the background. We recommend that you use the option to
run in background to increase the visibility of the target object and improve бот accuracy. The following
actions support background processing:
• Щелчок
• Установить текст
• Получить текст

Безопасная запись

Если включен режим безопасной записи, боты не отображают изображения целевых объектов после
съемки. Это гарантирует, что конфиденциальные данные не будут показаны.

Прим.:  Несмотря на то, что боты не отображают целевые изображения после записи, изображения
все еще хранятся в памяти Control Room, потому что они необходимы для запуска боты.

Когда вы записываете задание в режиме безопасной записи, в окне Предварительный просмотр
временно отображается изображение захваченной области. Это изображение будет скрыто после
того, как вы переместитесь за пределы окна Bot editor или обновите его.
Этот параметр должен быть включен пользователем с полномочиями администратора. См. раздел
Настройки.

Поддержка прокси-сервера

Если ваше устройство настроено на использование прокси-сервера, все исходящие запросы
пакет будут направляться через прокси-сервер. См. раздел Подключение Bot Agent к устройству с
использованием прокси-сервера.

© 2023 Automation Anywhere. All rights reserved.     1769

https://apeople.automationanywhere.com/s/article/Your-Chrome-Plugin-is-either-not-installed-or-disabled
https://apeople.automationanywhere.com/s/article/Your-Chrome-Plugin-is-either-not-installed-or-disabled


    Automation Anywhere - Сборка

Примеры использования средства записи

Используйте эти примеры заданий, чтобы ознакомиться с использованием средства записи при
создании боты.
• Example of entering data into a web form from a worksheet
• Example of extracting data from a web table

Ссылки, связанные с данной
Universal Recorder for object-based automation
Use the Universal Recorder to record interactions, such as click, read (data extraction), and write (data
entry), with user interface (UI) objects on the desktop, taskbar, or in an application or browser window.
AISense для записи задач из удаленных приложений
AISense — это способность искусственного интеллекта (ИИ) в Automation 360, которая помогает
идентифицировать объекты на изображении или в приложении со сложным пользовательским
интерфейсом (UI), а также повысить скорость и точность автоматизации в любых средах.

Actions performed on objects captured with Universal Recorder
After capturing the object, specify the action for the бот to do to the object at runtime. Например, если
вы записали гиперссылку, вы можете выбрать действие, чтобы щелкнуть по ссылке или извлечь
текст ссылки. Refer to the table below for the objects and their possible actions.

Прим.:
• After you have captured an object and open the Action drop-down list, the list might offer actions for

an object that are not supported. Only use the actions for an object that are listed in the table below.
• You can capture any control type which is not yet supported by Microsoft UI Automation (COM)

technology as Client control. You can perform all actions that are available in Client control type
but only those actions that are supported for that specific control. For example, if you are capturing a
slider control which is not yet supported by Microsoft UI Automation (COM) technology, it is captured
as a Client control. You can perform only those actions that are supported by the slider control. For
example, you can perform the Click, Left click, Right click, and Double click actions but you
cannot perform the Set text action.

Объект Действия

Кнопка • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Click
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click
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Объект Действия

Флажок • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get status: retrieves whether the check box is selected. Returns
checked or unchecked.

• Check
• Uncheck
• Set focus
• Toggle: switches the check box to the opposite status. For example, if

the check box is checked, use the Toggle action to clear it.
• Left click: use this action if the Toggle action does not work during

Runtime.
• Right click
• Double click

Клиент • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get all children names: retrieves the names of all the child elements
of the captured control.
The child elements are the elements or controls that are available
under the parent control and are only visible when you use spy tools
like AccChecker.

• Get all children values: retrieves the values of all the child elements
of the captured control.

• Set text: enters text into the UI object. It supports credentials.
Credentials and credential variables in the Bot editor

• Click
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click
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Объект Действия

ComboBox (appears as
a drop-down list)

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get total items: retrieves the number of items in the box.
• Get selected index: retrieves the item's position in the menu.

Прим.:  Item index counts start at 1.

• Get selected item key: retrieves the key of the selected item.

Прим.:  The Microsoft UI Automation (COM) technology does not
support this .

• Get selected text: retrieves the data from the selected item.
• Select item by index: selects the item that is located at the specified

index.

Прим.:  Item index counts start at 1.

• Select item by text selects the item that matches the specified text.

Прим.:  The Assign value field is case-sensitive.

• Set focus

Прим.:  The Microsoft UI Automation (COM) technology does not
support this .

• Expand

Прим.:  The Microsoft UI Automation (COM) technology does not
support this .

• Click

Прим.:  The Microsoft UI Automation (COM) technology does not
support this .

• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click
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Объект Действия

GridView (SAP only) • Click on cell by index

Прим.:  Index count starts at 1.

• Double click current cell
• Get total rows: retrieves the number of rows that contain values.
• Get total columns: retrieves the number of columns that contain

values.
• Get cell text by index: retrieves the data in the specified cell located

at the row and column index.

Прим.:  Row and column index counts start at 1. For example, to
retrieve the data in cell A2, enter 1 in the Row field and 2 in the
Column field.

• Get cell index by text: retrieves the index of the cell containing the
specified text.

Прим.:  The Cell Text field is case-sensitive.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get table: retrieves the table data and saves it to a Table variable.
Для получения дополнительной информации см. раздел Example of
extracting data from a web table

• Select all
• Set cell by index: enters text into the cell located at the row and

column index.

Прим.:  Row and column index counts start at 1. For example, to
enter text into cell A2, enter 1 in the Row field and 2 in the Column
field.

• Set cell by text: enters text into the cell containing the specified text.

Прим.:  The Find Text field is case-sensitive.

• Set current cell
• Set current row
• Set focus
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Метка • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Set focus
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click
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Объект Действия

Link

Прим.:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Click
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Представление в виде
списка

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get total items: retrieves the number of items in the list.
• Get selected index: retrieves the item's position in the menu.

Прим.:  Item index counts start at 1.

• Get selected text: retrieves the data from the selected item.
• Select item by index: selects the item that is located at the specified

index.

Прим.:  Item index counts start at 1.

• Select item by text selects the item that matches the specified text.

Прим.:  The Assign value field is case-sensitive.

• Click
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Main window

Прим.:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Get focus control id: retrieves the ID of the control that is in focus.
• Get property: retrieves the value of the specified object property

(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Set focus
• Send key
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click
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Объект Действия

Menu

Прим.:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get total items: retrieves the number of items in the menu.
• Get selected index: retrieves the item's position in the menu.

Прим.:  Item index counts start at 1.

• Get selected text: retrieves the data from the selected item.
• Select item by index: selects the item that is located at the specified

index.

Прим.:  Item index counts start at 1.

• Select item by text selects the item that matches the specified text.

Прим.:  The Assign value field is case-sensitive.

• Set focus
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Вкладка страницы • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get total items: retrieves the number of items in the tab.
• Get selected index: retrieves the item's position in the menu.

Прим.:  Item index counts start at 1.

• Get selected text: retrieves the data from the selected item.
• Select item by index: selects the item that is located at the specified

index.

Прим.:  Item index counts start at 1.

• Select item by text selects the item that matches the specified text.

Прим.:  The Assign value field is case-sensitive.

• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Прим.:  When you capture a Page Tab control using Microsoft UI
Automation (COM) technology and perform Left click, Right click, or
Double click actions on the control, the actions will click on the point of
capture.
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Объект Действия

Password text • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Set text: enters text into the UI object. It supports credentials.
Credentials and credential variables in the Bot editor

• Click
• Left click: use this action if the Click action does not work during

Runtime.
• Right click
• Double click

RadioButton • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get status: retrieves whether the radio button is selected. Returns
selected or deselected.

• Select
• Set focus
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Shell

Прим.:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Slider

Прим.:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Set position
• Right click
• Double click

Tab

Прим.:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Scroll left
• Select
• Set focus
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click
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Объект Действия

Таблица • Deselect all
• Get property: retrieves the value of the specified object property

(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get cell text by index: retrieves the data in the specified cell located
at the row and column index.

Прим.:  Row and column index counts start at 1. For example, to
retrieve the data in cell A2, enter 1 in the Row field and 2 in the
Column field.

Прим.:  For the Microsoft UI automation (COM) technology, the row
and column index counts start at 1, which includes the header row and
the leftmost column.

• Get cell index by text: retrieves the index of the cell containing the
specified text.

Прим.:  The Cell Text field is case-sensitive.

• Get table: retrieves the table data and saves it to a Table variable.
Подробнее см. в разделе Example of extracting data from a web table.
• When you use the Microsoft UI Automation (COM) technology to

capture the control, the Get table action also extracts the leftmost
column and header rows in the table.

• Get total rows: retrieves the number of rows that contain values.

Прим.:  When you use the Microsoft UI Automation (COM) technology
to capture the control, the Get total rows action extracts a greater
number of rows (including the header in the rows) when compared to
the older technologies .

• Get total columns: retrieves the number of columns that contain
values.

Прим.:  When you use the Microsoft UI Automation (COM) technology
to capture the control, the Get total columns action extracts a
greater number of columns (including the leftmost column) when
compared to the older technologies .

• Select row
• Select all
• Set cell by index: enters text into the cell located at the row and

column index.

Прим.:  Row and column index counts start at 1. For example, to
enter text into cell A2, enter 1 in the Row field and 2 in the Column
field.

Прим.:  For the Microsoft UI Automation (COM) technology, the row
and column index counts start at 1, which includes the header row and
the leftmost column.

• Set cell by text: enters text into the cell containing the specified text.

Прим.:  The Find Text field is case-sensitive.

• Set focus
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Прим.:  When you capture the table, the properties of item element are
also captured. You cannot use these captured properties as a selection
criterion because during бот runtime, the property value of item cannot be
searched.
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Объект Действия

Текстовое поле • Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Set focus
• Set text: enters text into the UI object. It supports credentials.

Credentials and credential variables in the Bot editor
• Append text: adds text to the end of existing text in the field, instead

of overwriting it.
• Click
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Toolbar

Прим.:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Tree (Control is
displayed as a ListView)

Прим.:  The Microsoft
UI Automation (COM)
technology does not
support this control.

• Expand node: expands the current node to down to the next level of
nodes.

• Get property: retrieves the value of the specified object property
(such as the link text) and optionally saves it to a variable. For more
information, see the Object properties section.

• Get total items: retrieves the number of items in the tree.
• Get selected index: retrieves the item's position in the menu.

Прим.:  Item index counts start at 1.

• Get selected text: retrieves the data from the selected item.
• Select item by index: selects the item that is located at the specified

index.

Прим.:  Item index counts start at 1.

• Select item by text selects the item that matches the specified text.

Прим.:  The Assign value field is case-sensitive.

• Set focus
• Left click: use this action if the Click action fails during runtime.
• Right click
• Double click

Using the Capture action
Use the Capture action to capture a single interaction (click, keystroke, or mouse movement) with an
object control including a text box, button, table, menu, radio button, combo box, check box, list view, link,
tree, or page tab.
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• To use the Средство записи, you must already have done the following:
• Установка Bot Agent и регистрация устройств
• Set user device credentials

• Configure device display and font scale to 100%.
If you are using Средство записи пакет version 2.0.6-20200626-193519 or later, you can record tasks
in Google Chrome, Internet Explorer, Java, Microsoft Active Accessibility, and Microsoft UI automation
applications on a computer that has display scale configured to 100%, 125%, or 150%.

• If you are automating a task using a browser, configure the zoom level to 100%.
If you are using Средство записи пакет version 2.0.6-20200626-193519 or later, you can record tasks
in a Google Chrome browser that does not have a zoom level setting of 100%.

• If you are automating a task using a Google Chrome browser, ensure that the Automation Anywhere
plug-in that corresponds with the Automation 360 build version is enabled.

Требования к браузеру для доступа к Рабочая область RPA
• To automate web applications running on Microsoft Edge Chromium browser in Internet Explorer mode

using the Universal Recorder, ensure that the Internet Explorer compatibility mode is enabled. The
objects on the web applications are captured using HTML technology. To enable this mode, perform the
following steps:
1. On the Microsoft Edge Chromium browser page, click Settings.
2. On the left panel, click Default browser.
3. Navigate to the Allow sites to be reloaded in Internet Explorer mode option and select

Allow.
4. Click Add to add the URL of the page that you want to load in Internet Explorer mode.

Прим.:  The pages that you add open in Internet Explorer mode for 30 days from the date when
you add the page.

Considerations when recording a task:
• Use clicks when possible rather than shortcut keys.

When you click an object using the Средство записи, it retrieves the object's properties that enable the
бот to identify the object at runtime. Keyboard shortcuts are less reliable, so use them when it is not
possible to automate the task by a clicking an object.

• If you are automating a task using a browser, do not use autofill to enter values into fields.
• Record the task at low speed.
• Avoid dragging windows during the recording process.
• Avoid clicking on applications that are not part of the process you are recording and automating.
• When Internet Explorer is used, the action waits until the browser is completely rendered and is in a

ready state before executing the action.

To record a single interaction with an object control, follow these steps:
1. Double-click or drag Recorder > Capture.
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2. Specify the window in which to capture an object.
Choose from the Application, Browser, or Variable tab.
Вариант Описание

Приложение Select from a list of currently active windows.
This option shows a list of all the application
and browser windows that are open on the Bot
Creator device.

Браузер Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based
, and  browsers. For all other browsers, use the
Application option.

Переменная Выберите существующую переменную окна,
чтобы задать заголовок в заголовке окна
приложения.

3. Необязательно: Вставьте символ подстановочного знака (*) в поле Заголовок окна для поиска
заголовков окон, которые могут меняться. You can specify one or more wildcards (*) at the start,
middle, or end of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The  first searches for
the exact window title (Microsoft), and if it does not find a match, it searches for windows with the
term Microsoft anywhere in the title.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
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you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Прим.:  During runtime, verify that the TaskBot identifies the correct window. If it does not, do the
following:
a. Open the application or browser window.
b. Drag a Window > Get active window title action above the Recorder > Capture action.
c. Insert a string variable into the Assign the window title to variable field.
d. Drag a Window > Set title action below the Window > Get active window title action.
e. In the Window field, insert the window variable generated by the Recorder > Capture action.
f. In the New window title field, insert the string variable from the Get active window title

action.
g. Щелкните Сохранить.

4. Необязательно: Select the Resize window option to specify the window dimensions.
This option delivers a more reliable бот. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the ботto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Прим.:  This option is available only for windows that can be resized. It is not available for the
Desktop or Taskbar options.

5. Click Capture object.
The selected window appears.

6. Move the mouse over the object you want to automate, for example, a button, form field, or a table.
A red rectangular box appears around the object.

Прим.:  If the box does not appear and you are capturing in either the Google Chrome, Microsoft
Edge, or Mozilla Firefox browsers, verify that you have enabled the Automation Anywhere extensions
for these browsers. See Google Chrome browser extension requirements for Google Chrome browser.

7. Click the object.
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8. Review the Object properties table.
Following are the list of object properties that are selected by default based on the technology type:

Important:  The following list does not include all the properties and is restricted to the most
commonly used and important properties based on the technology type

Technology type Свойства объекта Описание

Тип элемента
управления

This is a read-only property that shows the type
of object captured, for example, text box or
button.

DOMXPath It is the path that is used to locate the control or
object that is captured. DOMXPath can be of
two types: Relative XPath and Absolute XPath.
• Absolute Xpath: It contains the complete

path from the root element to the desired
element. For example, an absolute Xpath
for this topic would be /html/body/div/
div[1]/main/div[2]/div/div/div[2]/
div/div/div[1]/div/article/main/
article/div/p[1]

• Relative Xpath: This is a shorter path that
refers to an element you want to identify.
A relative path starts with a // symbol.
For example, the relative XPath for this
topic would be //*[@id="cloud-using-
recorder-action"]/div/p[1]

For example, if you want to find the DOMXPath
of a particular element on Google Chrome
browser, perform these steps:
a. Select the element for which you want to

extract the XPath.
b. Right-click the element and select Inspect.
c. Right-click the highlighted element in the

Element tab.
d. Go to Copy > Copy Xpath to copy the

relative path and select Copy > Copy full
Xpath to copy the absolute path.

Путь It is a numeric representation of the position
of a particular control in an application. For
web applications, the best practise is to use
DOMXPath from the search criteria when
comapred to Path.

HTML name and
ID

These properties are used to identify an HTML
object

HTML Technology

HTML inner text The DOM innerText Property is used to set or
return the text content of a specified node and its
descendants
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Technology type Свойства объекта Описание

HTML tag HTML tags are like keywords that define the
way web browser formats and displays the
content. For example, if the captured text has an
HTML code: <h3 class="search_results-
title">Search results for ״string
 package״</h3>, then enter h3 in the HTML
tag field.

Тип элемента
управления

This property is used only as a reference to
ensure that the correct object is captured

Путь It is a numeric representation of the position of a
particular control in an application

Имя This specifies a name of an element and works as
an identifier

Microsoft Active
Accessibility

Идентификатор This specifies the ID of an element and works as
an identifier

Тип элемента
управления

This property is used only as a reference to
ensure that the correct object is captured

Java Technology

Путь It is a numeric representation of the position of a
particular control in an application

Тип элемента
управления

This property is used only as a reference to
ensure that the correct object is captured

Путь It is a numeric representation of the position of a
particular control in an application

Имя This specifies a name of an element and works as
an identifier

Microsoft UI
Automation

Идентификатор This specifies the ID of an element and works as
an identifier

Тип элемента
управления

This property is used only as a reference to
ensure that the correct object is captured.

Путь It is a numeric representation of the position of a
particular control in an application.

Имя This specifies a name of an element and works as
an identifier.

Microsoft UI
Automation (COM)

Идентификатор This specifies the ID of an element and works as
an identifier.

The бот uses the selected properties to identify the object control at runtime.
a) Verify that the Control Type matches your intended object.

For example, when capturing a table from a website, ensure the Control Type and HTML Tag
values are Table.
If the Control Type does not match your intended object, recapture the object control.

b) Select and assign values to the object properties that you want to include in the object search.
For a more reliable бот, we recommend that you select only the properties that have static values
(such as Name, Class, Type, HTML ID, and DOMXPATH), and deselect the properties that
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have dynamic values (such as HTML Href, Path or Value), which are subject to change and
cause бот errors.
It is a best practice to use the wildcard character (*) or variable in object property values to
search for objects whose properties are dynamic and changes frequently.

9. Select the Action from the drop-down list.
For a full list of possible actions by object, see Actions performed on objects captured with Universal
Recorder.
• If you record a click and keystrokes in a text box with a Control Type of Password text, the

Recorder does not capture the keystrokes entered into the field. Instead, the action selects the
Set text option and offers options to securely input the password. We recommend that you store
the password in the Credential Vault and insert it into the action as a credential.
See Credentials and credential variables in the Bot editor.
If you navigate to the text box using the TAB keystroke instead of a click in an MSAA or SAP
application, the Recorder is able to identify fields with a Control Type of Password text.

• If the selected Action supports background processing, a Run in the background option
appears.
См. раздел Фоновая обработка.

10. Необязательно: Enter a value in the Keep trying for (seconds) field to specify the number of
seconds the бот must wait for the object control to appear on the application window.
We recommend setting a delay time when using the Set text action to enter keystrokes into a text
field.

Прим.:  The timeout specified for the бот to wait for the control to appear on the application window
applies only if the window in which the control is present exists. The Средство записи first looks for
the application window and only then searches for the object inside that window. The default time
to search for the window is 30 seconds. Hence, even if you specify the wait time as 5 seconds, it still
waits for 30 seconds by default if the window does not exist.

Прим.:  We recommend that you first use a wait time of 0 second and ensure that the application
window exists and then specify a wait time of 5 seconds and run the бот to detect the object.

11. Необязательно: Assign the output to a variable.
The Control Room suggests a descriptive default variable name based on the action you
selected in step 8. For example, if you selected Get property, the suggested output variable is
PropertyValue. If you create several output variables, subsequent variable names are appended
with a -1 to avoid duplication.

12. Щелкните Сохранить.
The captured images are not added as dependencies and will not be displayed in the dependencies list
when you check in your бот.

Link an object to a supporting anchor

Прим.:  You can use object anchoring in Microsoft Active Accessibility, Microsoft UI Automation, or Java
applications.

At runtime, if the бот cannot reliably identify an object, link it to a nearby object (such as a link or button)
that is easier for the бот to find:
1. Open the Capture action.
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2. Click the Anchor tab.
3. Click Capture anchor.

The browser or application window activates with the main object highlighted (the object that you
previously captured). A dialog box appears, verifying whether the action has correctly identified the
main object.

4. If the correct object is highlighted, click Yes, Select anchor.
Otherwise, click No, I need to correct it to select the correct object.

5. Select a nearby object to the target object that is easier for the бот to find.
The object is highlighted with an anchor icon on the right of the object.

6. Click Save.

Capture using specific technology
In some applications, the Capture action might not work accurately if the technology for capturing is
selected automatically. In such cases, based on the type of application that you want to automate, you can
select a specific technology and use the Capture action to capture using that technology.

Using the Capture action

To select a specific technology, click the drop-down next to Capture object.
You can select a specific technology and automate the following applications:
• Automate web applications that have nested iFrames with the same frame source or different frame

sources.
• Capture and automate objects on applications where automatic selection of technology might not

capture accurately.

Прим.:  When you capture using a specific technology, the type and the number of object properties
differ.

• Automate all objects and controls on the Google Chrome and Microsoft Edge browsers for local setting
pages.

Прим.:  Эта функция поддерживается для браузеров Google Chrome и Microsoft Edge.

Technology types

Вы можете записывать объекты с помощью следующих технологий:
• Microsoft Active Accessibility (MSAA)
• Microsoft UI Automation
• Microsoft UI Automation (COM)

Microsoft Active Accessibility (MSAA)

Microsoft Active Accessibility is a legacy accessibility technology that was introduced as a platform add-
in for Windows 95. MSAA is designed to help Assistive Technology (AT) products interact with standard
and custom user interface elements of an application and also to access, identify, and manipulate an
application's UI elements. MSAA is based on the Component Object Model (COM), which defines a
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mechanism for applications and operating systems to communicate. To know more about the most
commonly used properties in this technology, see Using the Capture action.

Microsoft UI Automation

Microsoft UI Automation is an accessibility framework for Microsoft Windows, and it is available on
all operating systems that support Windows Presentation Foundation (WPF). UI Automation provides
programmatic access to most user interface elements on the desktop, enabling AT products such as screen
readers to provide information about the UI to end users and to manipulate the UI by means other than
standard input. To know more about the most commonly used properties in this technology, see Using the
Capture action.

Microsoft UI Automation (COM)

Microsoft UI Automation (COM) runs on unmanaged code and delivers automation faster than UI
Automation. You can capture the following controls using the Microsoft UI Automation (COM) technology:
• Кнопка
• Флажок
• Клиент
• Поле со списком
• Метка
• List view
• Вкладка страницы
• Password text
• Переключатель
• Таблица
• Текстовое поле

When you select this technology to capture an object on an application, if that object is not supported for
the technology, that is indicated by a gray highlight around the object.

Прим.:  Microsoft UI Automation (COM) provides a search criterion (property) called Automation ID,
which is unique to this technology.

Средство записи actions supported in various SAP versions
Review the information about the various actions of the Средство записи пакет that are supported with
Automation 360 and which SAP GUI versions support them.
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Control
name

Automation
360
supported
action

SAP Logon
730 (Patch
15)

SAP Logon
740 (Patch
19)

SAP Logon
750 (Patch
10)

SAP Logon
760 (Patch
5)

SAP Logon
770 (Patch
6)

Установить
текст

Да Да Да Да Да

Добавить
текст

Да Да Да Да Да

Получить
свойство

Да Да Да Да Да

Настроить
фокус

Да Да Да Да Да

Left-click Да Да Да Да Да

Right-click Да Да Да Да Да

Текстовое
поле
(Включают
в себя
такие
элементы
управления,
как
GuiCTextField,
GuiTextField,
GuiOkCodeField,
GuiShell:TextEdit,
GuiTextEdit,
and
GuiPasswordField)

Double-click Да Да Да Да Да

Выбрать
элемент по
индексу

Да Да Да Да Да

Выбрать
элемент по
тексту

Да Да Да Да Да

Выбрать
элемент по
ключу

Да Да Да Да Да

Развернуть Да Да Да Да Да

Получить
общее
число
элементов

Да Да Да Да Да

Получить
выбранный
текст

Да Да Да Да Да

Get selected
item key

Да Да Да Да Да

Получить
выбранный
индекс

Да Да Да Да Да

Получить
свойство

Да Да Да Да Да

Настроить
фокус

Да Да Да Да Да

Left-click Да Да Да Да Да

Поле со
списком
It includes
the control:
GuiCombobox

Right-click Да Да Да Да Да
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Control
name

Automation
360
supported
action

SAP Logon
730 (Patch
15)

SAP Logon
740 (Patch
19)

SAP Logon
750 (Patch
10)

SAP Logon
760 (Patch
5)

SAP Logon
770 (Patch
6)

Double-click Да Да Да Да Да

Установить Да Да Да Да Да

Снять Да Да Да Да Да

Переключить Да Да Да Да Да

Получить
состояние

Да Да Да Да Да

Получить
свойство

Да Да Да Да Да

Настроить
фокус

Да Да Да Да Да

Left-click Да Да Да Да Да

Right-click Да Да Да Да Да

Флажок
It includes
the control:
GuiCheckBox

Double-click Да Да Да Да Да

Щелчок Да Да Да Да Да

Получить
свойство

Да Да Да Да Да

Set Focus Yes Yes Yes Yes Да

Left-click Да Да Да Да Да

Right-click Да Да Да Да Да

Кнопка
It includes
the control:
GuiButton

Double-click Да Да Да Да Да

Выбрать Да Да Да Да Да

Получить
состояние

Да Да Да Да Да

Получить
свойство

Да Да Да Да Да

Настроить
фокус

Да Да Да Да Да

Left-click Да Да Да Да Да

Right-click Да Да Да Да Да

Переключатель
It includes
the control:
GuiRadioButton

Double-click Да Да Да Да Да

Установить
ячейку по
индексу

Да Да Да Да ДаТаблица
It includes
the control:
GuiTableControlУстановить

ячейку по
тексту

Да Да Да Да Да
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Control
name

Automation
360
supported
action

SAP Logon
730 (Patch
15)

SAP Logon
740 (Patch
19)

SAP Logon
750 (Patch
10)

SAP Logon
760 (Patch
5)

SAP Logon
770 (Patch
6)

Get cell text
by index

Да Да Да Да Да

Get cell
index by text

Да Да Да Да Да

Получить
общее
число строк

Да Да Да Да Да

Get total
columns

Да Да Да Да Да

Выбрать
строку

Да Да Да Да Да

Выбрать все Да Да Да Да Да

Отменить
выбор всех

Да Да Да Да Да

Получить
свойство

Да Да Да Да Да

Настроить
фокус

Да Да Да Да Да

Left-click Да Да Да Да Да

Right-click Да Да Да Да Да

Double-click Да Да Да Да Да

Получить
таблицу

Да Да Да Да Да

Выбрать
элемент по
тексту

Да Да Да Да Да

Получить
свойство

Да Да Да Да Да

Настроить
фокус

Да Да Да Да Да

Left-click Да Да Да Да Да

Right-click Да Да Да Да Да

Double-click Да Да Да Да Да

Получить
общее
число
элементов

Да Да Да Да Да

Строка
меню
It includes
the
control:GuiMenubar

Выбрать
элемент по
индексу

Да Да Да Да Да
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Control
name

Automation
360
supported
action

SAP Logon
730 (Patch
15)

SAP Logon
740 (Patch
19)

SAP Logon
750 (Patch
10)

SAP Logon
760 (Patch
5)

SAP Logon
770 (Patch
6)

Выбрать
элемент по
тексту

Да Да Да Да Да

Expand node Да Да Да Да Да

Получить
свойство

Да Да Да Да Да

Настроить
фокус

Да Да Да Да Да

Получить
общее
число
элементов

Да Да Да Да Да

Получить
выбранный
индекс

Да Да Да Да Да

Получить
выбранный
текст

Да Да Да Да Да

Выбрать
элемент по
индексу

Да Да Да Да Да

Выбрать
элемент по
тексту

Да Да Да Да Да

Left-click Да Да Да Да Да

Right-click Да Да Да Да Да

Дерево
It includes
the control:
GuiShell::Tree

Double-click Да Да Да Да Да

Выбрать Да Да Да Да Да

Прокрутка
влево

Да Да Да Да Да

Получить
свойство

Да Да Да Да Да

Настроить
фокус

Да Да Да Да Да

Left-click Да Да Да Да Да

Right-click Да Да Да Да Да

Табуляция
It includes
the control:
GuiTab

Double-click Да Да Да Да Да
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Control
name

Automation
360
supported
action

SAP Logon
730 (Patch
15)

SAP Logon
740 (Patch
19)

SAP Logon
750 (Patch
10)

SAP Logon
760 (Patch
5)

SAP Logon
770 (Patch
6)

Выбрать все Да Да Да Да Да

Select cell by
index

Да Да Да Да Да

Select cell by
text

Да Да Да Да Да

Set current
cell row

Да Да Да Да Да

Выбрать
строку

Да Да Да Да Да

Щелкнуть
ячейку по
индексу

Да Да Да Да Да

Doube-click
current cell

Да Да Да Да Да

Получить
общее
число строк

Да Да Да Да Да

Get total
columns

Да Да Да Да Да

Get cell by
index

Да Да Да Да Да

Get cell
index by text

Да Да Да Да Да

Получить
свойство

Да Да Да Да Да

Настроить
фокус

Да Да Да Да Да

Left-click Да Да Да Да Да

Right-click Да Да Да Да Да

Double-click Да Да Да Да Да

Grid view
It includes
the control:
GuiShell::GridView

Получить
таблицу

Да Да Да Да Да

Отправить
VKey

Да Да Да Да Да

Get focus
control ID

Да Да Да Да Да

Получить
свойство

Да Да Да Да Да

Главное
окно
It includes
the control:
GuiMainWindow

Настроить
фокус

Да Да Да Да Да
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Control
name

Automation
360
supported
action

SAP Logon
730 (Patch
15)

SAP Logon
740 (Patch
19)

SAP Logon
750 (Patch
10)

SAP Logon
760 (Patch
5)

SAP Logon
770 (Patch
6)

Left-click Да Да Да Да Да

Right-click Да Да Да Да Да

Double-click Да Да Да Да Да

Нажмите
кнопку по
индексу

Да Да Да Да Да

Select
content
menu item
by text

Да Да Да Да Да

Получить
свойство

Да Да Да Да Да

Left-click Да Да Да Да Да

Right-click Да Да Да Да Да

Панель
инструментов
It includes
the control:
Toolbar
 control

Double-click Да Да Да Да Да

Получить
свойство

Да Да Да Да Да

Настроить
фокус

Да Да Да Да Да

Left-click Да Да Да Да Да

Right-click Да Да Да Да Да

Метка
It includes
the control:
GuiLabel

Double-click Да Да Да Да Да

Получить
свойство

Да Да Да Да Да

Настроить
фокус

Да Да Да Да Да

Left-click Да Да Да Да Да

Right-click Да Да Да Да Да

Остальные
элементы
управления
(Включают
в себя
такие
элементы
управления,
как
GuiMainWindow,
GuiBox,
GuiUserArea,
GuiTitlebar
и
GuiStatusbar)

Double-click Да Да Да Да Да
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Веб-служба REST пакет
Используйте actions в пакет Веб-служба REST в качестве методов (DELETE, GET, PATCH, POST или
PUT) для отправки запросов в API-интерфейс и получения ответов из него.

Работа с actions Веб-служба REST

Предоставьте следующую информацию для отправки запроса REST и получения ответа. Не все
параметры требуются для всех методов.
• Enter the URI: Уникальный адрес для ресурса API.
• Proxy configuration: To set the proxy, select the System or Custom tab from Proxy configuration.

Вариант Описание

Система System proxy is the proxy configured on
the бот runner machine where the бот is
running.
If this option is selected, the Bot Agent uses
the system proxy.
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Вариант Описание

Пользовательский This option allows you to configure
custom proxy settings within the actions
of Веб-служба REST. For example, if a
REST API is required to be routed through
a different proxy other than the system
proxy, you can select the Custom option and
provide proxy details within the REST actions.
Укажите следующие сведения:
Укажите следующие сведения:
• Узел. The host name or IP address of the

proxy
• Порт. The port number of the proxy
• Username (Optional): The username

used for the proxy authentication
• Password (Optional): The password

used for the proxy authentication

Прим.:  If the proxy to be configured
is authenticated proxy, then you must
provide authentication credentials in the
Username and Password fields.

For Host, Port, Username, and Password
fields, choose from Credential, Variable, or
Insecure string tab :
• Учетные данные. Use a value available

in the credential vault.
• Переменная. Use a variable that stores

a credential value in a user-defined
variable.

• Insecure string: Manually specify the
value that you want to use.

• Режим проверки подлинности. Поддерживается три режима проверки подлинности.
• No Authentication: Use this option to access the endpoints that does not require authentication to

access their servers.
• Базовая. Basic is the simplest way to authenticate users. When you select this option, you will

enter the username and password. This technique uses a header called Authorization, with a base64
encoded representation of the username and password entered.

• Вошедший в систему пользователь AD. Пользователи Active Directory (AD), которым разрешен
доступ к связанному API-интерфейсу, проходят процедуру проверки подлинности через AD.
Вводить никакие учетные данные в запросе не требуется.

• Проверка подлинности NT LAN Manager (NTLM) (пользователь AD). Метод проверки
подлинности «Задача/ответ» позволяет клиентам предоставлять свое имя пользователя
и пароль в виде зашифрованных учетных данных или обычного текста. Рекомендуется
использовать учетные данные, которые хранятся в файле Credential Vault Automation
Anywhere.
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• Заголовок. Не для всех методов требуется заголовок. Заголовки представляют собой
метаданные, связанные с запросом.

• Тип содержимого. Если заголовок содержит тип содержимого, он определяет согласование
содержимого между клиентом и сервером. actions Веб-служба REST поддерживают следующие
типы содержимого.
• application/x-www-form-urlencoded: Encode the parameters in the URL.
• JSON (application/json): Enter a JSON request body.
• XML (application/xml): Enter an XML request body.
• Text (text/plain)
• XML (text/xml)
• HTML (text/html)
• multipart/form-data: Send binary data, in most cases for uploading files to the server.

• Add substitution: Allows you to enter variables in the REST request body. A variable is a symbolic
representation of data, and it enables you to access a value without having to enter it manually
wherever you need it. For example, consider the following REST body request:

{
   "name":"{{name}}",
   "email":"{{email}}",
   "status":"Active"
}

In the above request body, you can replace the variables enclosed within double braces by clicking Add
substitution and adding the required values.

• Advanced options:
• Сделать снимок ответа на сбой. Установите флажок, чтобы сделать снимок ответа на сбой,

за исключением ответа Успешно/ОК. Детали ответа на сбой записываются в теле ответа.
• Разрешить небезопасное подключение при использовании https. Установите флажок,

чтобы разрешить небезопасное подключение при использовании https.

• Время ожидания завершения действия. Вы можете установить значение ожидания при
отправке запроса REST и получении ответа. При выполнении таких actions, как POST, PUT,
DELETE, PATCH и GET, для параметра Время ожидания завершения действия можно
указать время ожидания (в миллисекундах). По умолчанию время ожидания составляет
60 000 миллисекунд.

• Выходные переменные. Выходное значение ответа записывается в переменную словаря.
Переменная словаря — это пара «ключ-значение». Используйте имя заголовка ответа в качестве
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ключа, чтобы вернуть значение заголовка, или «Body» в качестве ключа, чтобы вернуть тело
ответа.

Прим.:  Ключ ответа и его значение доступны в переменной словаря для отображения статуса
ответа API-интерфейса REST.

Чтобы получить список имен заголовков для ресурса API, выполните следующие действия.
1. Вставьте action Цикл после action Веб-служба REST.
2. Выберите итератор Для каждого ключа в словаре.
3. В поле Переменная словаря выберите переменную, которая содержит выходное значение

action Веб-служба REST.
4. Assign the value of each key to $prompt-assignment$.
5. Вставьте action Записать в файл.
6. Укажите путь к текстовому файлу, в котором будет храниться список имен заголовков.
7. Insert $prompt-assignment$ in the Enter text to log field.
8. Выберите параметр Заменить существующий файл.
9. Щелкните Сохранить.

При выполнении бот имена заголовков будут записаны из ресурса API в выбранный файл.

Безопасная передача значений

Вы можете безопасно передавать значения из Credential Vault в веб-службу, указав учетные данные
ячейка и атрибут в следующих поддерживаемых полях action.
• URI
• Настраиваемые заголовки
• Тело. For the application/x-www-form-urlencoded content type, click Add parameter to

select the value from the Credential Vault.
Для всех остальных типов содержимого выберите Выбрать учетные данные в качестве
параметров и щелкните Выбрать.

Действия в Веб-служба REST пакет

Действие Описание

Метод Delete Удаление ресурса, идентифицированного с помощью URI.
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Действие Описание

Метод Get Извлечение информации, определенной с помощью параметров,
включенных в URI. Тип содержимого для метода GET отсутствует,
поскольку все параметры передаются как часть URI.
К ограничениям и характеристикам метода GET относятся
следующие.
• Длина URI не может превышать 2048 символов.
• Все параметры передаются в URI.
• Метод GET раскрывает данные, содержащиеся в URI, что делает

его менее безопасным, чем метод POST.
• Метод GET не изменяет никаких данных, что делает его

безопасным для всех пользователей независимо от авторизации.

См. раздел Using the Get method.

Метод Patch Изменение ресурса, идентифицированного с помощью URI.

Метод Post Создание нового ресурса в URI.
• Параметры передаются в теле запроса.
• Длина тела запроса не ограничена.

См. раздел Using the Post method.

Метод Put Обновление или замена ресурса на основе параметров, переданных в
URI или теле запроса. См. раздел Using the Put method.

Поддержка прокси-сервера

Если ваше устройство настроено на использование прокси-сервера, все исходящие запросы
пакет будут направляться через прокси-сервер. См. раздел Подключение Bot Agent к устройству с
использованием прокси-сервера.
Задачи, связанные с данной
Example of building a бот that uses credential variables
Securely pass values to a бот using credential variables to automate the process of logging in to a bank
website.
Ссылки, связанные с данной
Credentials and credential variables in the Bot editor
Use credentials when building боты to pass sensitive information such as passwords and account numbers.
Using credentials separates the sensitive information from the боты and Bot Runner, which reduces the
risk of data spillage or unauthorized user access.

Using the Get method
Use the Get method actions from the Веб-служба REST пакет to retrieve or get the information
identified by parameters included in the URI .
This example uses endpoints from the Swagger Petstore sample API (Petstore) to demonstrate using Get
method action to retrieve data from the Petstore database.
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Прим.:  GET method action does not take any request body.

1. Create a new .
a) Выполните вход в экземпляр .
b) На левой панели щелкните Автоматизация.
c) Щелкните Создать > Бот.
d) In the Create Task Bot window, enter the  name.
e) Accept the default folder location: \Bots\

To change the default  storage location, click Choose and follow the prompts.
f) Щелкните Создать и редактировать.
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2. Use the Get method action to retrieve a list of all the available pets.
a) Double-click or drag the REST Web Services > Get method action.
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b) Enter the following URI:

https://petstore.swagger.io/v2/pet/findByStatus?status=available

c) Under Authentication Mode drop-down, select No Authentication as this endpoint does not
require authentication.

Прим.:  Typically endpoint requires authentication to ensure that only authorized applications are
able to access the data. Select an appropriate authentication mechanism to allow access to the
endpoint you want to access.

d) Create the variable Output in the Assign the output to a variable field. For more information
on creating a variable, see Create a variable.

3. Insert a Log to file action to see the response body.
a) Double-click or drag the Log to file action.
b) Provide the file path to a text file.
c) In the Enter text to log field, enter $Output{Body}$.

4. Click Save and then click Run.
The бот retrieves the response body and saves it to the text file.

См. также:
• Веб-служба REST пакет
• Using the Post method
• Using the Put method
• Upload file with Put method

Using the Post method
Use the Post method actions from the Веб-служба REST пакет to create new resources in the URI.
This example uses endpoints from the Swagger Petstore sample API (Petstore) to demonstrate using Post
method action to add data to the Petstore database.
1. Create a new .

a) Выполните вход в экземпляр .
b) На левой панели щелкните Автоматизация.
c) Щелкните Создать > Бот.
d) In the Create Task Bot window, enter the  name.
e) Accept the default folder location: \Bots\

To change the default  storage location, click Choose and follow the prompts.
f) Щелкните Создать и редактировать.
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2. Use the Post method action to add a new pet to the store.
a) Double-click or drag the REST Web Services > Post method action.

© 2023 Automation Anywhere. All rights reserved.     1802



    Automation Anywhere - Сборка

b) Enter the following URI:

https://petstore.swagger.io/v2/store/order

c) Under Authentication Mode drop-down, select No Authentication as this endpoint does not
require authentication.

Прим.:  Typically endpoint requires authentication to ensure that only authorized applications are
able to access the data. Select an appropriate authentication mechanism to allow access to the
endpoint you want to access.

d) Copy and paste the following into the Custom parameters field, replacing the text in the angle
brackets with the value that you copied from the file:

{
  "id": 0,
  "petId": 0,
  "quantity": 0,
  "shipDate": "2022-04-20T22:08:11.977Z",
  "status": "placed",
  "complete": true
}

e) Create the variable Output in the Assign the output to a variable field. For more information
on creating a variable, see Create a variable.

3. Insert a Message box action to see the response body.
a) Double-click or drag the Log to file action.
b) In the Enter the message to display field, enter $Output{Body}$.

4. Click Save and then click Run.
The бот displays the response in the message box.

See also

• Веб-служба REST пакет
• Using the Get method
• Using the Put method
• Upload file with Put method

Using the Put method
Use the Put method actions from the Веб-служба REST пакет to update or replace existing resource.
This example uses endpoints from the Swagger Petstore sample API (Petstore) to demonstrate using Put
method action to update data to the Petstore database.
1. Use the Put method action to update the pet name to "Pluto" and pet status to "sold".

a) Double-click or drag the REST Web Services > Put method action.
b) Enter the following URI:

https://petstore.swagger.io/v2/pet

c) Open the log file saved in Using the Get method and copy the Pet ID of the first entry.
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d) Copy and paste the following into the Custom parameters field, replacing the text in the angle
brackets with the value that you copied from the file:

{
  "petId": 0,
   "name": "Pluto",
  "status": "sold"
}

e) Insert the variable Output in the Assign the output to a variable field.

2. Move the Message box action below the Put method action:
a) Double-click or drag the Message box action.
b) In the Enter text to log field, enter $Output{Body}$.

3. Click Save and then click Run.
The бот retrieves the response body and prints it to the Message box. A successful response includes
"name":"Pluto","status":"sold".

See also

• Веб-служба REST пакет
• Using the Post method
• Using the Get method
• Upload file with Put method

Upload file with Put method
Use the Put method action in the Веб-служба REST пакет to upload a file or text.
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This example uses endpoints from the Petstore sample API (Petstore) to demonstrate uploading a new
file or text using a multipart/form-data.
1. Use the Put method action in conjunction with an API that allows uploading a file.

a) Double-click or drag the REST Web Services > Put method action.
b) Enter the following URI:

https://petstore.swagger.io/v2/pet/112/uploadImage

c) From the Content type drop-down, select multipart/form-data.

d) Add the file parameter and provide the path of the file to be uploaded.
e) Add any other required parameters. For instance, this API takes additonatalMetadata (for

example, "hello"), which is a text input parameter. The additional parameter will also be uploaded.
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2. Assign the output to a variable, for example, Test123.

3. Print the output in a message box.

See also

• Веб-служба REST пакет
• Using the Post method
• Using the Get method
• Using the Put method

Метод Delete
Use the Delete method action in the Веб-служба REST пакет to remove a resource that is identified by
the URI.

Метод Patch
Use the Patch method action in the Веб-служба REST пакет to action modify the resource that is
identified by the URI.
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Salesforce пакет
Salesforce is a cloud-based platform that provides software and services to create relevant customer
experiences.
Salesforce is based on a multi-tenant architecture with benefits such as API integration, configuration,
scalability, free capacity, platform support, and more. The Salesforce пакет uses the Lightning Platform
APIs to integrate Automation 360 with Salesforce. RPA developers need to authenticate to build
automation processes in Salesforce. After authentication, with the Salesforce Connected App, you can
upload or download files, perform CRUD (Create/Insert, Read, Update/Upsert, Delete) operations on
Objects (Salesforce stores data as Objects), and query using SOQL.
The following video shows the initial authentication and command actions from Automation 360:
Two types of objects are available in Salesforce, Standard Objects and Custom Objects. Standard Objects
include the configuration and default data types. Custom Objects are the objects that are defined
according to business requirements. In this topic, sample CRUD operations will be based on the Case
Object, which is a Standard Object. A Case Object is typically used to gather customer data (queries,
feedback, or problems). All the samples are based on manipulating the fields of the Case Object. For more
information on the Case Object, see Salesforce Case object. All the CRUD operations are initiated from the
Automation 360 side and will update data on the Salesforce side.

Salesforce Authentication action
Salesforce Authentication is the first command action that you need to call to get authenticated with
the Salesforce.
Authenticate access to Salesforce by getting the authentication parameters from the Salesforce connected
app and using them in Automation 360.
1.

Log in to the Salesforce Enterprise Edition (Lightning Experience - Salesforce Login), click , and
select Setup on your connected app. For more information about creating a new connected app, see
Configure RPA Bots for Salesforce callback integration.
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2. In the Lightning Experience App Manager, click App Manager.

3. Click the down arrow next to app name and select View.
The Manage Connected Apps screen appears. For more information about managing connected
apps, see Salesforce Connected Apps.
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4. Click Manage Consumer Details.
a) Click Copy that corresponds to Consumer Key.
b) Click Copy that corresponds to Consumer

Secret.

5. Войдите в Control Room.
6. Create a new .

a) Выполните вход в экземпляр .
b) На левой панели щелкните Автоматизация.
c) Щелкните Создать > Бот.
d) In the Create Task Bot window, enter the  name.
e) Accept the default folder location: \Bots\

To change the default  storage location, click Choose and follow the prompts.
f) Щелкните Создать и редактировать.
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7. From the Actions pane, select Salesforce > Authentication and place it under the Start of the бот
flow.
Вариант Шаги

Client ID/Client secret/ Salesforce
username/Salesforce password

Select one of the following options to specify
the Client ID/Client secret/ Salesforce
username/Salesforce password:
• Учетные данные. Enables you to use a

value available in the Credential Vault that
contains information about the Client ID/
Client secret/ Salesforce username/Salesforce
password.

• Переменная. Enables you to use a
credential variable that contains information
about the Client ID/Client secret/ Salesforce
username/Salesforce password.

• Insecure string: Enables you to enter the
Client ID/Client secret/ Salesforce username/
Salesforce password for the Salesforce
Authentication.

a) In the Client ID field, paste the Consumer Key copied from the Salesforce Connected App. In
this illustration Insecure string is used, while you can use Credential or Variable options for
better security.
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b) In the Client Secret field, paste the Consumer Key copied from the Salesforce Connected App.

c) Enter the Salesforce username.
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d) Enter the Salesforce password.
e) Enter the API version. You can find the API version using the https://

MyDomainName.my.salesforce.com/services/data/" format="html"
 scope="external, replace MyDomainName with your Salesforce URL. For more information
on obtaining the Salesforce URL, see the below step.

f) Select Production to log into a live environment or Sandbox to log into a testing environment.
g) Enter Default as the Session name.

8. Create either a Multiple or Dictionary variable to store the response. You can do one of the
following:
• The authentication command returns a dictionary with 2 key-value pairs. Authorization

(credential type) and InstanceUrl (String type). The Authorization is hidden, but you will be
able to read the InstanceUrl. For example, you can use a message box to print of the value of ,
$str_Authresponse{InstanceUrl}$, this returns the Salesforce URL.

• You can select Multiple variable as shown below and map to a credential variable and a string
variable as keys.

Authorization returns a token, which is hidden as it is a credential type, this token can be passed
directly in the Rest Web Services command.

9. Click Run to save and run your бот. Once authenticated, you will be able to use the token to call
other Salesforce API services.

Salesforce Insert record action
Use the Salesforce Insert record action to insert a new record into a Salesforce object along with values
of the fields that should be mapped to the object's fields.

Прим.:  Ensure that you are authenticated before calling any Salesforce action. For more information
about authentication, see Salesforce Authentication action.

In this tutorial, you will insert a few fields into a Salesforce object by using the Insert record action.
1. From the Actions pane, select Salesforce > Insert record and place it in the canvas.
2. Enter the following fields:

a) Enter the Object name, for example, Case.

Прим.:  For Salesforce Custom objects, ensure that you provide the API name
instead of the Display name of the object. For example, provide API name:
AAIRPA__Salesforce_Connection__c and not the display name: Salesforce Connection"

© 2023 Automation Anywhere. All rights reserved.     1812

https://aasd-foundation-int-dev-ed.lightning.force.com/one/one.app#/setup/ObjectManager/01I4W000002b1TO/view


    Automation Anywhere - Сборка

For more information on how to find the API name, see https://help.salesforce.com/s/articleView?
id=000327123&type=1.
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b) Enter the Fields and data that you want to insert. Choose either Dictionary or Entry list. In
this sample, Dictionary is selected and a few fields in Case object are modified. For example,
Status is set to New and Origin is set to Web.
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c) Enter Default as the session name.
d) Save the outcome to a variable. For example, the object ID is saved to Str_RecordID.
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3. Verify whether the value is inserted into Salesforce.
a) Find the value of the Str_RecordID variable in the Debug mode.

b) In Salesforce, go to the Case object with the record ID (for example, 5004W000026rD5tQAE) that
you received as the response.
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Verify whether the field's values match the input that you sent from Automation 360. For
example, in this case, the Status is New and Case Origin is Web.

Salesforce Get record action
The Salesforce Get record action is used to read the fields of a Salesforce object.

Прим.:  Ensure that you are authenticated before calling any Salesforce action. For more information
about authentication, see Salesforce Authentication action.

To read the field of a Salesforce object by using the Get record action, perform the following steps:
1. From the Actions pane, select Salesforce > Get record and place it in the canvas.
2. Enter the following fields:

a) Enter the Object name, for example, Case.

Прим.:  For Salesforce Custom objects, ensure that you provide the API name
instead of the Display name of the object. For example, provide API name:
AAIRPA__Salesforce_Connection__c and not the display name: Salesforce Connection"
For more information on how to find the API name, see https://help.salesforce.com/s/articleView?
id=000327123&type=1.
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b) Enter the Record ID that you want to read. You will also be able to read data using the
External ID. For more information on External ID, see Salesforce Upsert record action.
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c) Select List for the Fields and data (Optional) field. Enter all the fields that you want to read.
In this sample, the field Status is read.

d) Save the outcome to a variable. For example, the object ID is saved to SFDC_Res.

3. Click Run to start the бот. You will be able to read the value of the field by simply printing the value
in a Message box action. For example, in this sample, $SFDC_Res{Status}$ will print New

Salesforce Update record action
Update the fields of Salesforce Objects by using the Salesforce Update record action.

Прим.:  Ensure that you are authenticated before calling any Salesforce action. For more information
about authentication, see Salesforce Authentication action.

To update a field in a Salesforce Object by using the Update record action, perform the following steps:
1. From the Actions pane, select Salesforce > Update record and place it in the canvas.
2. Enter the following fields:

a) Enter the Object name, for example, Case.

Прим.:  For Salesforce Custom objects, ensure that you provide the API name
instead of the Display name of the object. For example, provide API name:
AAIRPA__Salesforce_Connection__c and not the display name: Salesforce Connection"
For more information on how to find the API name, see https://help.salesforce.com/s/articleView?
id=000327123&type=1.
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b) Enter the Record ID that you want to update.
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c) In the Fields and data (Optional) field, select Entry List. Click Add new field/value pair to
update and enter the Field name that you want to update and the Field value (optional) that
you want the field to be updated with. For example, enter Status as Field name and In progress
as Field value (optional) in Fields and data. You can also choose Dictionary and enter the
values as a key/value pair.

d) Save the outcome to a variable. For example, the object ID is saved to SFDC_Res.
e) Enter the Record ID that you want to update.

3. To start the бот, click Run. You can verify the update by checking it in the Salesforce side. The
following video shows the process:

Salesforce Delete record action
Delete records from Salesforce by using the Salesforce Delete record action.

Прим.:  Ensure that you are authenticated before calling any Salesforce action. For more information
about authentication, see Salesforce Authentication action.

To delete a field of a Salesforce object, use the Delete record action.
1. From the Actions pane, select Salesforce > Delete record and place it in the canvas.
2. Enter the following fields:

a) Enter the Object name, for example, Case.

Прим.:  For Salesforce Custom objects, ensure that you provide the API name
instead of the Display name of the object. For example, provide API name:
AAIRPA__Salesforce_Connection__c and not the display name: Salesforce Connection"
For more information on how to find the API name, see https://help.salesforce.com/s/articleView?
id=000327123&type=1.
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b) Enter the Record ID that you want to delete.

3. Click Run to start the бот. You will be able to verify the deletion by checking it on the Salesforce side.
The following video shows the process:

Salesforce Upsert record action
Insert or update a record by using the Salesforce Upsert record action. The Upsert action uses a
custom external ID as the key to identify a record.
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Прим.:  Ensure that you are authenticated before calling any Salesforce action. For more information
about authentication, see Salesforce Authentication action.

1. From the Actions pane, select Salesforce > Upsert record (using External ID) and place it in
the canvas.
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2. Enter the Object name, for example, Case.
3. Enter the field name that will store the ExternalID.

Прим.:  In this sample, the ExternalID is generated by using the Generate random string action.

4. Enter the ExternalID generated.
5. Enter the fields that you want to update.
6. To verify, you can store the generated recordID in a variable. The following video demonstrates how to

inserting fields to a record created in Salesforce.

7. To update a field by using the Upsert record action, from the Actions pane, select Salesforce >
Upsert record (using External ID) and place it in the canvas.

8. Enter the Object name, for example, Case.

Прим.:  For Salesforce Custom objects, ensure that you provide the API name
instead of the Display name of the object. For example, provide API name:
AAIRPA__Salesforce_Connection__c and not the display name: Salesforce Connection"
For more information on how to find the API name, see https://help.salesforce.com/s/articleView?
id=000327123&type=1.

9. Enter the same field name that will store the ExternalID.
10. Enter the same ExternalID to refer to the same record.
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11. Enter the Field Name and new Field Value to update in Fields and data. You can also choose
Dictionary and enter the values as a key/value pair.

12. To verify, you can store the outcome to a variable, for example, Dict_ExternalId-update.

Salesforce Execute SOQL action
To search your Salesforce data for specific information, run the Salesforce Object Query Language (SOQL)
command from Automation 360 by using the Salesforce Execute SOQL action.
SOQL is similar to Structured Query Language (SQL) but is tailored for Salesforce data. For more
information about SOQL, see Salesforce Execute SOQL.

© 2023 Automation Anywhere. All rights reserved.     1829

https://developer.salesforce.com/docs/atlas.en-us.228.0.soql_sosl.meta/soql_sosl/sforce_api_calls_soql.htm


    Automation Anywhere - Сборка

To get specific information from Salesforce data, execute a query from Automation 360.
To send an SOQL query to Salesforce by using the Execute SOQL action, perform the following steps:

Прим.:  Ensure that you are authenticated before calling any Salesforce action. For more information
about authentication, see Salesforce Authentication action.

1. From the Actions pane, select Salesforce > Execute SOQL and place it in the canvas.

2. Enter the following fields:
a) Enter the SOQL query to execute, for example, Select Status From Case Where Id =

'5004W000026rD4HQAU'.

Прим.:  For Salesforce Custom objects, ensure that you provide the API name
instead of the Display name of the object. For example, provide API name:
AAIRPA__Salesforce_Connection__c and not the display name: Salesforce Connection"
For more information on how to find the API name, see https://help.salesforce.com/s/articleView?
id=000327123&type=1.

b) Select one of the following options:
• If you want to include the deleted records, select Yes.
• If you do not want to include the deleted records, select No.

c) Enter Default as the session name.
d) Save the outcome to a variable. For example, all the fields of the records can be stored in a list

(List_SOQL)
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3. Verify that you can run the бот in Debug mode with a breakpoint set to an action next to Execute
SOQL. For example, in the sample provided previously, there is a Message box action. Open the
List_SOQL variable to view the results.

Salesforce Upload file attachment action
You can upload a file to a record in Salesforce with the Salesforce Upload file attachment action.

Прим.:  Ensure that you are authenticated before calling any Salesforce action. For more information
about authentication, see Salesforce Authentication action.

1. From the Actions pane, select Salesforce > Upload file attachment and place it in the canvas.
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2. Enter the following fields:
a) Enter the Object's record ID to which you want to upload the file. Пример.

'5004W000026rD4HQAU'.
b) Enter a Content document record ID (optional).

It is necessary only when you want to upload a newer version of an existing file.
c) Select a location from where you want to upload the file. You will be able to select one of the

following:
Control Roomfile: When you select this option, you can select a file from your Control Room.
Desktop file: When you select this option, you can select a file from your computer. In this
sample, a file is uploaded from a folder in the computer.
Переменная. When you select this option, you can select variable that points to a file.

Прим.:  Make sure that the file path that you are referring to contains the file with the exact
name as entered in this field.

d) Enter the Display name (Optional) to save the uploaded file in this name.
e) Set the Visibility as required.
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• AllUsers: The file is available to all users who have permission to see the file.
• InternalUsers: The file is available only to internal users who have permission to see the file.
• SharedUsers: The file is available to all users who can see the feed to which the file is

posted. SharedUsers is used only for files shared with users and is available only when an
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org has private org-wide sharing on by default. The SharedUsers value is available in API
version 32.0 and later.

f) Enter Default as the session name.
g) Save the outcome to a variable. For example, the version of the saved document can be saved in

a variable, such as DocVersionID.

3. To verify, you can run the бот and see whether the file is uploaded to the record in the Salesforce. The
following video demonstrates uploading a file from a computer to Salesforce.

Salesforce Download file attachment action
You can download a file from a record in Salesforce by using the Salesforce Download file attachment
action.

Прим.:  Ensure that you are authenticated before calling any Salesforce action. For more information
about authentication, see Salesforce Authentication action.

1. From the Actions pane, select Salesforce > Download file attachment and place it in the canvas.
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2. Enter the following fields:
a) Enter the Object's record ID from which you want to download the file. Пример.

'5004W000026rD4HQAU'

b) Enter the Destination folder where you want to save the file.

c) Set Download all files/filter by to one of the following options:
All files: Download all the attached files from a record.
File name: Download a file by entering a file name.
File extension: Download all the files with the same extension that you enter.
Content document ID: Download a particular version of a file.

d) Enter Default as the session name.
e) Save the outcome to a variable. For example, the details of the downloaded files can be saved in

a variable, such as ListResponse
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3. To verify, you can run the бот and whether the file is downloaded to the specified location. The
following video demonstrates how to download a file from Salesforce to a location on a local system.

Прим.:  The file is downloaded from the ContentDocument Object.

SAP пакет
The SAP пакет contains actions to automate tasks and processes on a SAP application.
The SAP пакет enables you to perform the following tasks:
• Reduce the time required to combine data from disparate systems.
• Eliminate human error and increase efficiency.
• Increase the number of transactions processed.
• Deliver real-time information to various stakeholders.
• Enhance decision-making through comprehensive reports.

Прим.:  In SAP Connect action, the Session name field cannot be shared with TaskBots or any other
боты.

Предварительные условия

• Log in to the SAP GUI before capturing objects because the SAP Logon screen is not supported for
object capture.

• Enable GUI scripting and accessibility.
See Enabling Scripting on the Client Side, Enabling Scripting on the Server Side, and Enabling Accessibility
settings.

• Ensure that one of the following SAP GUI for Windows is installed on the devices that you use to
automate SAP-related tasks and to run these tasks:
• SAP GUI 750 with patch 9
• SAP GUI 760 with patch 0
• SAP GUI 760 with patch 1
• SAP GUI 760 with patch 5
• SAP GUI 770 with patch 6

Прим.:  If SAP GUI 760 with patch 0 is installed on your device, you cannot use the SAP Grid view
control Set Table cell text and Get Table Cell Text actions because of an issue with SAP GUI 760
with patch 0.

• Install a Scripting Tracker or a similar tool to retrieve the field path of the SAP object.

Перед началом работы
Выполните указанные ниже actions в рамках SAP пакет из числа доступных actions.
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1. Установите соединение с приложением SAP, используя action Подключить.
Log in to the SAP application using the SAP GUI application. Then use the Connect action from the
SAP пакет to use this connection and assign a session name. Используйте это же имя сеанса для
других actions.

2. Используйте actions для автоматизации задачи.
3. After you have automated all the SAP-related tasks, terminate the connection to the SAP application

using the Disconnect action.

Действия в SAP пакет

пакет SAP включает в себя указанные ниже actions.

Прим.:  The SAP and the Средство записи пакет can detect SAP elements in the application. However,
from a usability standpoint, the Средство записи пакет is preferred over the SAP пакет as it is more
intuitive when compared to the SAP пакет, such as detecting SAP Object paths automatically. См. Benefits
of using Средство записи пакет instead of SAP пакет

Действие Описание

Установить/снять
флажок

Check/uncheck check box action

Щелчок Click action

Щёлкнуть меню Click menu action

Подключить Using Connect action for SAP.

Отключить Disconnect action

Двойной щелчок Double click action

Развернуть Expand action

Экспорт таблицы Using Export table action.

Посчитать ячейки Get cell count action

Get children name Get children names action

Получить текст
потомка

Get children text action

Посчитать столбцы Get column count action

Получить число строк Get row count action

Получить выбранный
элемент

Get selected item action

Получить состояние Get status action

Получить индекс
ячейки таблицы

Get table cell index action
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Действие Описание

Получить текст
ячейки таблицы

Get table cell text action

Получить текст Get text action

Посчитать элементы Get item count action

Левый щелчок Left click action

Правый щелчок Right click action

Выбрать элемент Select item action

Выбрать
переключатель

Select radio option action

Отправить
виртуальный ключ

Virtual keys in SAP GUI

Send virtual key action

Установить текст
ячейки таблицы

Set table cell text.

Установить текст Set text action

Check/uncheck check box action
The Check/uncheck check box action in the SAP пакет enables you to select or clear a check box in a SAP
window.

Настройки

• In the Session name field, enter the session name you used to connect to the SAP application in the
Connect action.

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Action option, select Check, Uncheck, or Toggle.

Click action
The Click action in the SAP пакет enables you to perform a click operation.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.

Click menu action
The Click menu action in the SAP пакет enables you to click a menu item by text or index in a SAP
window.
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Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Select option, select Name or Index to specify the name or index of the menu item.

Using Connect action for SAP
Use the Connect action to establish a connection with a SAP system that you want to use to automate
SAP-related tasks. This must be the first action you use to automate an SAP-related task.
1. На палитре Действия дважды щелкните или перетащите action Подключить из пакет SAP.
2. Specify a name for the session in the Session name field.
3. Select an option to specify the connection type:

a) If you have selected Automatic, no additional information is required to connect to the SAP
application.
You must be already logged on to SAP logon application as the system uses the available SAP
session to connect to a SAP system.

b) If you have selected SAP GUI, you must manually provide the following details:
• Name: Specify the value in the Name field. The value must be same as entered in the

Description field of the SAP logon system connection parameters.
• Client: Specify a value for the client identifier. You can enter a value of 0 through 999.
• User name: Click the Credential tab to select an entry from the Credential Vault. You can

also click the String tab to enter a value manually.
• Password: Click the Credential tab to select an entry from the Credential Vault. You can also

click the String tab to enter a value manually.
• Language: Specify the two-letter code for the language set on the SAP server.

4. Щелкните Сохранить.

Задачи, связанные с данной
Using Export table action
Use the Export table action to export a table to a datatable or CSV file.
Using Set table cell text action
Use the Set table cell text action to set the text in a specific cell of a table or a grid.
Ссылки, связанные с данной
SAP пакет
The SAP пакет contains actions to automate tasks and processes on a SAP application.

Disconnect action
The Disconnect action in the SAP пакет enables you to terminate the connection to the SAP application.

Настройки

In the Session name field, enter the session name you used to connect to the  application in the
Connect .
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Double click action
The Double click action in the SAP пакет enables you to perform a double-click operation on a SAP
window.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.

Expand action
The Expand action in the SAP пакет enables you to expand the item by text or index on a SAP window.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Select option, select Text or Index to specify the text or index of the item.

Using Export table action
Use the Export table action to export a table to a datatable or CSV file.
To export a table, follow these steps:
1. In the Действия palette, double-click or drag the Export table action from the SAP пакет.
2. In the Session name field, enter the session name you used to connect to the SAP application in the

Connect action.
3. In the Field path field, specify the location or a string variable that contains the location of the

object.
You can use Средство записи capture action to capture SAP controls and retrieve the field path or
install a Scripting Tracker or a similar tool to retrieve the field path of the SAP object.

4. In the Export As option, select CSV or Datatable to specify the export option of the table cell:
Choice Шаги

CSV a. In the File Path field, specify the location or
file variable.

b. Необязательно. In the Encoding field,
specify the value.

c. Select the Export data with header check
box to export with header.

d. In the When saving field, select Append
to existing log file or Overwrite existing
log file to append the log file or overwrite
the content within the log file.

Datatable In the Datatable field, specify the value.
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5. Щелкните Сохранить.

Get cell count action
The Get cell count action in the SAP пакет enables you to get number of cells in a table or grid.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Assign the output to a variable field, specify the variable.

Get children names action
The Get children names action in the SAP пакет enables you to get children control names.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Assign the output to list variable field, specify the list variable.

Get children text action
The Get children text action in the SAP пакет enables you to get the text associated with children control.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Assign the output to list variable field, specify the list variable.

Get column count action
The Get column count action in the SAP пакет enables you to get number of columns in a table or grid.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Assign the output to a variable field, specify the variable.
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Get row count action
The Get row count action in the SAP пакет enables you to get number of rows in a table or grid.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Assign the output to a variable field, specify the variable.

Get selected item action
The Get selected item action in the SAP пакет enables you to get selected item index from a combo box,
page tab, or a tree view control.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Assign the output to a variable field, specify the variable.

Get status action
The Get status action in the SAP пакет enables you to get status of a radio button or check box.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Assign the output to a variable field, specify the variable.

Get table cell index action
The Get table cell index action in the SAP пакет enables you to get table cell index for text.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Search text field, specify the text.
• Select the Case sensitive search option to specify a case-sensitive search.
• Select the All occurrences check box.
• In the Assign the output to a variable field, specify the variable.
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Get table cell text action
The Get table cell text action in the SAP пакет enables you to get table cell text by index.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Row field, specify the number of row from which you want to get the text.
• In the Column field, specify the number of column from which you want to get the text.
• In the Assign the output to a variable field, specify the variable.

Get text action
The Get text action in the SAP пакет enables you to get text from a text box, label, or status bar.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Assign the output to a variable field, specify the variable.

Get item count action
The Get item count action in the SAP пакет enables you to get the count of items in a combo box, page
tab, or tree view control.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Assign the output to a variable field, specify the variable.

Left click action
The Left click action in the SAP пакет enables you to perform a left-click operation.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.

Right click action
The Right click action in the SAP пакет enables you to perform a right-click operation.
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Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.

Select item action
The Select item action in the SAP пакет enables you to select an item by text or index.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Select option, select Text or Index to specify the text or index of the item.

Select radio option action
The Select radio option action in the SAP пакет enables you to select the radio button in a SAP window.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.

Send virtual key action
The Send virtual key action in the SAP пакет enables you to send a virtual key.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Select list, select a key.
See Virtual keys in SAP GUI.

Using Set table cell text action
Use the Set table cell text action to set the text in a specific cell of a table or a grid.
To set a value in a table cell, follow these steps:
1. In the Действия palette, double-click or drag the Set table cell text action from the SAP пакет.
2. In the Session name field, enter the session name you used to connect to the SAP application in the

Connect action.
3. In the Field path field, specify the location or a string variable that contains the location of the

object.
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4. In the Select option, select Text or Index to specify the text or index of the table cell:
• Text: In the Find Text field, specify the value.

The system searches for the cell that contains the value.
• Index: In the Row and Column fields, specify the value.

5. In the Set Text field, enter the text to set the table cell.
6. Щелкните Сохранить.

Set text action
The Set text action in the SAP пакет enables you to set the text in an editable field.

Настройки

• In the Session name field, enter the session name you used to connect to the  application in the
Connect .

• In the Field path field, specify the location or a string variable that contains the location of the object.
• In the Field value field, specify the text.

Прим.:  You can set the fields to any value, including blank values, for example, text field or date field.

• Select the Append text check box.

пакет SAP BAPI
пакет SAP BAPI содержит actions для автоматизации задач и процессов с помощью интерфейса
для программирования бизнес-приложений (Business Application Programming Interface; BAPI) SAP.
BAPI — это стандартизированный метод, позволяющий сторонним приложениям взаимодействовать
с системой SAP.

Overview of SAP BAPIs

Business Application Programming Interfaces (BAPIs) are APIs that enable external applications to access SAP
business objects.
Typically, a BAPI consists of the following parameters:
• Import parameters: Used to receive data from the calling applications.
• Export parameters: Used to return data to the calling application.
• Import/export table parameters: Tables used for both receiving data and returning data.

A parameter can be of the following type:
• Data element: Scalar data type
• Структура. Typically contains multiple fields

If an import parameter is of the type structure, you can pass multiple values as key-value pairs.
• Таблица. A data structure that contains more than one row

For a BAPI method to work, the calling application can call the method in a BAPI using the following:
• Имя BAPI
• Import parameters (scalar, structure, table)
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• Export parameters (scalar, structure, table)

Перед началом работы
В пакет SAP BAPI выполните указанные ниже actions из числа доступных actions.
1. Установите соединение с приложением SAP, используя action Подключить.
2. Используя action Создать функцию, создайте определяемую пользователем функцию для

указанной функции SAP BAPI.
Выберите параметр Начало последовательности, чтобы отметить начало процесса, а затем
actions для автоматизации задачи.

3. Используя action Выполнить функцию, выполните функцию, созданную в ходе выполнения
действия Создать функцию.
Выберите параметр Конец последовательности, чтобы отметить окончание процесса, и
параметр Завершение транзакции для фиксации изменений.

Действия в пакет SAP BAPI

пакет SAP BAPI обеспечивает выполнение указанных ниже actions.

Действие Описание

Подключить Using Connect action for SAP BAPI.

Создать функцию Create function action.

Получить значение
поля

Get field value action.

Получить структуру Get structure action.

Получить таблицу Get table action.

Выполнить функцию Run function action.

Задать значение поля Set field value action.

Запустить
стандартный рабочий
процесс

Run standard workflow action.

Запустить
настраиваемый
рабочий процесс

Run custom workflow action.

Build sample боты using the SAP BAPI пакет

If you are getting started with the SAP BAPI пакет, a good place to start is to build some sample боты
with the help of the following tutorials. The tutorials are intended to train you on how to use various
actions from the SAP BAPI пакет to invoke SAP BAPIs, pass import parameters, and retrieve data from
export parameters.
• Example of using Get structure command from SAP BAPI пакет: In this tutorial, you will build a  that

invokes BAPI_FLIGHT_GETLIST from the SAP demo Flight Data application. When executed, the  calls
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the BAPI function by inputting an airline ID and destination details, gets a list of flights, and writes the
response data to a CSV file.

• Example of writing data to SAP using SAP BAPI пакет: In this tutorial, you will build a  that invokes
BAPI_FLCUST_CREATEFROMDATA from the SAP demo Flight Data application. You will use the
CUSTOMER_DATA import parameter to pass the customer data to the BAPI. When executed, the 
creates a new customer record in SAP database and displays the customer number returned by the
BAPI.

• Example of using Run standard workflow from SAP BAPI пакет: In this tutorial, you will build a бот that
uses a single action to select a BAPI from a list of function modules, to set import parameters, and to
get the response data. When executed, the бот gets flight availability data based on the input data, and
writes it to a CSV file.

Using Connect action for SAP BAPI
Use the Connect action to establish a connection with a SAP system that you want to use to automate
SAP-related tasks using SAP Business Application Programming Interface (BAPI). This must be the first
action you use to automate an SAP-related task using SAP BAPI.
Download the SAP Java connector package and DLL from the SAP website.
1. На палитре Действия дважды щелкните или перетащите action Подключить из пакет SAP.
2. Specify a name for the session in the SAP BAPI Session field.
3. Select one of the following options to specify the location of the SAP Java connector пакет:

• Control Room file: Enables you to select the SAP Java connector пакет that is available in a
folder in the Control Room.

• Desktop profile: Enables you to select the SAP Java connector пакет that is available on your
device.

• Переменная. Enables you to specify the file variable that contains the location of the SAP Java
connector пакет.

4. Select one of the following options to specify the location of the SAP JCo DLL dependency:
• Control Room file: Enables you to select the SAP Java connector DLL that is available in a folder

in the Control Room.
• Desktop profile: Enables you to select the SAP Java connector DLL that is available on your

device.
• Переменная. Enables you to specify the file variable that contains the location of the SAP Java

connector DLL.

5. Select one of the following options to specify the connection type:
Вариант Шаги

Сервер пользовательских приложений Select one of the following options to specify the
SAP server hostname:
• Учетные данные. Enables you to use a

value available in the Credential Vault that
contains information about the SAP server
hostname.

• Переменная. Enables you to use a
credential variable that contains information
about the SAP server hostname.

• Insecure string: Enables you to enter the
hostname for the SAP server.
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Вариант Шаги

Группа/сервер a. Select one of the following options to specify
the SAP message server hostname:
• Учетные данные. Enables you to use

a value available in the Credential Vault
that contains information about the SAP
message server hostname.

• Переменная. Enables you to use
a credential variable that contains
information about the SAP message
server hostname.

• Insecure string: Enables you to specify
the hostname for the SAP message
server.

b. Необязательно. Specify the gateway host
you want to use to connect to the server in
the Gateway host field.

c. Необязательно. Specify the logon group
you want to use to connect to the server in
the Logon group field.

6. Enter values for the following:
• Номер системы
• Необязательно. Идентификатор системы экземпляра SAP
• Номер клиента
• Код языка для входа в систему
• Необязательно. Строка маршрутизатора
• Select one of the following options to specify the username you want to use to connect to the SAP

server:
• Учетные данные. Enables you to use a value available in the Credential Vault that contains

the username.
• Переменная. Enables you to use a credential variable that contains the username.
• Insecure string: Enables you to enter the username.

• Select one of the following options to specify the password you want to use to connect to the SAP
server:
• Учетные данные. Enables you to use a value available in the Credential Vault that contains

the password.
• Переменная. Enables you to use a credential variable that contains the password.
• Insecure string: Enables you to enter the password.

7. Щелкните Сохранить.

Create function action
The Create function action in the SAP BAPI пакет enables you to create an alias for a SAP BAPI function
and saves it with an alias name.
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Настройки

Вы можете использовать имя псевдонима в других actions, чтобы использовать данную функцию
BAPI в этих actions.
• В поле Имя сеанса введите имя сеанса, который использовался для подключения к приложению

SAP в ходе выполнения action Подключить.
• В поле Имя псевдонима функции введите псевдоним, который будет использоваться для

функции BAPI.
• В поле Имя BAPI введите имя функции SAP BAPI, для которой требуется создать псевдоним.
• Если требуется выполнить BAPI в определенной последовательности, выберите параметр

Начало последовательности, чтобы отметить начало процесса.

Get field value action
The Get field value action in the SAP BAPI пакет enables you to obtain data of a specific field from a
function, table, or structure.

Настройки

• В поле Псевдоним функции BAPI введите псевдоним, который был указан для функции SAP
BAPI в ходе выполнения action Создать функцию.

• Выберите один из приведенных ниже параметров, чтобы указать, откуда требуется получить
данные: из функции, таблицы или структуры.
• Функция. Позволяет получить значение поля из функции.
• Таблица. Позволяет получить значение поля из таблицы в функции SAP BAPI.

Необходимо указать Псевдоним таблицы, из которой требуется получить данные.
Прежде чем использовать action Получить поле, чтобы получить значение поля из таблицы
в функции SAP BAPI, необходимо использовать action Получить таблицу. Кроме того,
необходимо указать Псевдоним таблицы, из которой требуется получить данные.

• Структура. Позволяет получить данные из структуры в приложении SAP.
Прежде чем использовать action Получить поле, чтобы получить значение поля из структуры
в функции SAP BAPI, необходимо использовать action Получить структуру. Кроме того,
необходимо указать Псевдоним таблицы, из которой требуется получить данные.

• В поле Имя поля введите имя поля, из которого требуется получить данные.
• In the SAP BAPI Session field, enter the session name you used to connect to the SAP application in

the Connect action.
• В поле Сохранить выходные данные в переменной укажите строковую переменную.

Get structure action
The Get structure action in the SAP BAPI пакет enables you to obtain table data from a structure using the
function alias.

Настройки

• В поле Псевдоним функции BAPI введите псевдоним, который был указан для функции SAP
BAPI в ходе выполнения  Создать функцию.
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• В поле Имя структуры введите имя структуры, из которой требуется получить данные.
• In the SAP BAPI Session field, enter the session name you used to connect to the  application in the

Connect .
• Чтобы указать, как должны быть сохранены данные, полученные из структуры, выберите один из

указанных ниже параметров.
• Псевдоним. Позволяет указать псевдоним для структуры и использовать его в других actions.
• Переменная. Позволяет сохранить данные, полученные из структуры, в переменной

таблицы.

Get table action
The Get table action in the SAP BAPI пакет enables you to get tabular data from a table using the function
alias.

Настройки

• В поле Псевдоним функции BAPI введите псевдоним, который был указан для функции SAP
BAPI в ходе выполнения  Создать функцию.

• В поле Имя таблицы введите имя таблицы, из которой требуется получить данные.
• In the SAP BAPI Session field, enter the session name you used to connect to the  application in the

Connect .
• Чтобы указать, как должны быть сохранены данные, полученные из таблицы, выберите один из

указанных ниже параметров.
• Псевдоним. Позволяет указать псевдоним для таблицы и использовать его в других actions.
• Переменная. Позволяет сохранить данные, полученные из таблицы, в переменной таблицы.

Run function action
The Run function action in the SAP BAPI пакет enables you to run the SAP BAPI function.

Настройки

• В поле Псевдоним функции BAPI введите псевдоним, который был указан для функции SAP
BAPI в ходе выполнения  Создать функцию.

• Выберите параметр Конец последовательности, чтобы отметить окончание процесса, и
параметр Завершение транзакции для фиксации изменений, внесенных во время выполнения
процесса.
Если требуется закончить последовательность, необходимо выбрать параметр Начало
последовательности из действия Создать функцию. Если использовалась очередь
удаленного вызова функций (qRFC), для фиксации внесенных изменений необходимо выбрать
параметр Завершение транзакции.

• In the SAP BAPI Session field, enter the session name you used to connect to the  application in the
Connect .

Set field value action
The Set field value action in the SAP BAPI пакет enables you to set data into a function, table, or structure
using the function alias.
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Настройки

• В поле Псевдоним функции BAPI введите псевдоним, который был указан для функции SAP
BAPI в ходе выполнения  Создать функцию.

• Выберите один из приведенных ниже параметров, чтобы указать, где требуется задать данные: в
функции, таблице или структуре.
• Функция. Позволяет задать данные в функции.
• Таблица. Позволяет задать данные в таблице в приложении SAP.

Прежде чем использовать action Получить поле, чтобы получить значение поля из таблицы
в функции SAP BAPI, необходимо использовать action Получить таблицу. Необходимо
указать Псевдоним таблицы, в которой требуется задать данные. Кроме того, можно
выбрать параметр Создать новую строку, если требуется создать новую строку в таблице и
задать значение в этой строке.

• Структура. Позволяет задать данные в структуре в приложении SAP.
Прежде чем использовать action Получить поле, чтобы получить значение поля из структуры
в функции SAP BAPI, необходимо использовать action Получить структуру. Кроме того,
необходимо указать Псевдоним структуры, из которой требуется получить данные.

• В поле Имя поля введите имя поля, в котором требуется задать данные.
• In the Field Value field, enter the value that you want to set.
• In the SAP BAPI Session field, enter the session name you used to connect to the  application in the

Connect .

Run standard workflow action
The Run standard workflow action in the SAP BAPI пакет enables you to run a standard workflow in SAP
BAPI.

Настройки

• Используя параметр Выбор рабочего процесса, выберите рабочий процесс в диалоговом окне
Селектор стандартного BAPI.

• В разделе Импортировать в BAPI отображаются параметры импорта для выбранного
рабочего процесса. Можно выбрать параметр Редактировать в меню действий (вертикальное
многоточие), чтобы задать значение для параметров.
• Выберите параметр Включить, если требуется использовать этот параметр импорта.
• Используйте вкладку Таблица, чтобы выбрать переменную таблицы, содержащую значения,

которые требуется импортировать в BAPI. Чтобы указать значение вручную, в качестве
альтернативы выберите Строки.

• В разделе Экспортировать в BAPI отображаются параметры экспорта для выбранного
рабочего процесса. Можно выбрать параметр Редактировать в меню действий (вертикальное
многоточие), чтобы задать значение для параметров.
• Выберите параметр Включить, если требуется использовать этот параметр экспорта.

• В разделе Таблицы отображаются таблицы, которые можно использовать в качестве
параметров экспорта или импорта для выбранного рабочего процесса. Можно выбрать
Редактировать в меню действий (вертикальное многоточие), чтобы задать значение для
таблиц.
• Выберите параметр Включить, если требуется использовать эту таблицу в качестве

параметра экспорта или импорта.
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• Выберите либо вкладку Импортировать для использования таблицы в качестве параметра
импорта, либо вкладку Экспорт для использования таблицы в качестве параметра экспорта.

• Используйте вкладку Таблица, чтобы выбрать переменную таблицы, содержащую значения,
которые требуется импортировать в BAPI. Чтобы указать значение вручную, в качестве
альтернативы выберите Строки.

• Если требуется выполнить BAPI в определенной последовательности, выберите параметр
Начало последовательности, чтобы отметить начало процесса.

• Выберите параметр Конец последовательности, чтобы отметить конец процесса.
• Выберите параметр Завершение транзакции для фиксации изменений, внесенных во время

выполнения процесса.
• In the SAP BAPI Session field, enter the session name you used to connect to the  application in the

Connect .
• В поле Сохранить экспортированные структуры и скаляры укажите переменную словаря.
• В поле Сохранить экспортированные таблицы укажите переменную словаря.

Run custom workflow action
The Run custom workflow action in the SAP BAPI пакет enables you to run a custom workflow in SAP
BAPI.

Настройки

Прим.:  Adding a custom workflow is currently not supported in Automation 360. You can use the Remote
function call (RFC) to execute the custom BAPI.

• Выберите настраиваемый рабочий процесс, который требуется запустить, из списка Выбор
настраиваемого рабочего процесса.

• В разделе Импортировать в BAPI отображаются параметры импорта для выбранного
рабочего процесса. Можно выбрать параметр Редактировать в меню действий (вертикальное
многоточие), чтобы задать значение для параметров.
• Выберите параметр Включить, если требуется использовать этот параметр импорта.
• Используйте вкладку Таблица, чтобы выбрать переменную таблицы, содержащую значения,

которые требуется импортировать в BAPI. Чтобы указать значение вручную, в качестве
альтернативы выберите Строки.

• В разделе Экспортировать в BAPI отображаются параметры экспорта для выбранного
рабочего процесса. Можно выбрать параметр Редактировать в меню действий (вертикальное
многоточие), чтобы задать значение для параметров.
• Выберите параметр Включить, если требуется использовать этот параметр экспорта.

• В разделе Таблицы отображаются таблицы, которые можно использовать в качестве
параметров экспорта или импорта для выбранного рабочего процесса. Можно выбрать
Редактировать в меню действий (вертикальное многоточие), чтобы задать значение для
таблиц.
• Выберите параметр Включить, если требуется использовать эту таблицу в качестве

параметра экспорта или импорта.
• Выберите либо вкладку Импортировать для использования таблицы в качестве параметра

импорта, либо вкладку Экспорт для использования таблицы в качестве параметра экспорта.
• Используйте вкладку Таблица, чтобы выбрать переменную таблицы, содержащую значения,

которые требуется импортировать в BAPI. Чтобы указать значение вручную, в качестве
альтернативы выберите Строки.
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• Если требуется выполнить BAPI в определенной последовательности, выберите параметр
Начало последовательности, чтобы отметить начало процесса.

• Выберите параметр Конец последовательности, чтобы отметить конец процесса.
• Выберите параметр Завершение транзакции для фиксации изменений, внесенных во время

выполнения процесса.
• In the SAP BAPI Session field, enter the session name you used to connect to the  application in the

Connect .
• В поле Сохранить экспортированные структуры и скаляры укажите переменную словаря.
• В поле Сохранить экспортированные таблицы укажите переменную словаря.

Экран пакет
Use the Экран пакет to automate the process of capturing screenshots. Using the actions in this package,
you can capture an area of an application window, the entire computer screen, or an active open window
and save it in a specified location in an image format.

Действия в Экран пакет

пакет Экран включает в себя указанные ниже actions.

Действие Описание

Захватить область См. раздел Using Capture area action from Экран пакет.

Захватить рабочий
стол

См. раздел Capture desktop action in Экран.

Захватить окно См. раздел Using Capture window action from Экран пакет.

Безопасная запись

Если включен режим безопасной записи, боты не отображают изображения целевых объектов после
съемки. Это гарантирует, что конфиденциальные данные не будут показаны.

Прим.:  Несмотря на то, что боты не отображают целевые изображения после записи, изображения
все еще хранятся в памяти Control Room, потому что они необходимы для запуска боты.

Когда вы записываете задание в режиме безопасной записи, в окне Предварительный просмотр
временно отображается изображение захваченной области. Это изображение будет скрыто после
того, как вы переместитесь за пределы окна Bot editor или обновите его.
Этот параметр должен быть включен пользователем с полномочиями администратора. См. раздел
Настройки.
Ссылки, связанные с данной
Screen resolution dependent пакеты
The screen resolution between the Bot Runner and Bot Creator device should be consistent as when
resolution-dependent пакеты are used to build боты, any screen resolution difference between the Bot
Creator and Bot Runner device will impact the боты during runtime.
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Using Capture area action from Экран пакет
Use the Capture area action in the Экран пакет to capture a screenshot of the application window area.
To capture a specified area of an application window, perform these steps:
1. In the Действия palette, double-click or drag the Capture area action from the Экран пакет.
2. Specify the window in which to capture an object.

Choose from the Application, Browser, or Variable tab.
Вариант Описание

Приложение Select from a list of currently active windows.
This option shows a list of all the application
and browser windows that are open on the Bot
Creator device.

Браузер Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based
, and  browsers. For all other browsers, use the
Application option.

Переменная Выберите существующую переменную окна,
чтобы задать заголовок в заголовке окна
приложения.

3. Необязательно: Вставьте символ подстановочного знака (*) в поле Заголовок окна для поиска
заголовков окон, которые могут меняться. You can specify one or more wildcards (*) at the start,
middle, or end of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The  first searches for
the exact window title (Microsoft), and if it does not find a match, it searches for windows with the
term Microsoft anywhere in the title.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
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you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Прим.:  During runtime, verify that the TaskBot identifies the correct window. If it does not, do the
following:
a. Open the application or browser window.
b. Drag a Window > Get active window title action above the Recorder > Capture action.
c. Insert a string variable into the Assign the window title to variable field.
d. Drag a Window > Set title action below the Window > Get active window title action.
e. In the Window field, insert the window variable generated by the Recorder > Capture action.
f. In the New window title field, insert the string variable from the Get active window title

action.
g. Щелкните Сохранить.

4. Необязательно: Select the Resize window option to specify the window dimensions.
This option delivers a more reliable бот. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the ботto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Прим.:  This option is available only for windows that can be resized. It is not available for the
Desktop or Taskbar options.

5. Click the Capture region.
The pixel coordinates of the captured area are displayed in the X, Y, Width, and Height fields. You
can modify these values.

6. Browse to select the File path to save image.
The following file extensions are supported: png, bmp, jpeg, tiff, gif, and wmf.

7. Click Overwrite file to replace an existing file with the same name.
8. Щелкните Сохранить.

Capture desktop action in Экран
The Capture desktop action in the Экран пакет enables you to capture an image of the entire desktop.

Настройки

• In the File path to save image field, specify the path where you want to save the captured image.
The following file extensions are supported: png, bmp, jpeg, jpg, tiff, gif, and wmf.

• Select Overwrite File check box to overwrite an existing file with the same name.
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Using Capture window action from Экран пакет
Use the Capture window action of the Экран пакет to capture an open application window.
To capture an application window, perform these steps:
1. In the Действия palette, double-click or drag the Capture window action from the Экран пакет.
2. Specify the window in which to capture an object.

Choose from the Application, Browser, or Variable tab.
Вариант Описание

Приложение Select from a list of currently active windows.
This option shows a list of all the application
and browser windows that are open on the Bot
Creator device.

Браузер Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based
, and  browsers. For all other browsers, use the
Application option.

Переменная Выберите существующую переменную окна,
чтобы задать заголовок в заголовке окна
приложения.

3. Необязательно: Вставьте символ подстановочного знака (*) в поле Заголовок окна для поиска
заголовков окон, которые могут меняться. You can specify one or more wildcards (*) at the start,
middle, or end of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The  first searches for
the exact window title (Microsoft), and if it does not find a match, it searches for windows with the
term Microsoft anywhere in the title.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when

© 2023 Automation Anywhere. All rights reserved.     1856



    Automation Anywhere - Сборка

you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Прим.:  During runtime, verify that the TaskBot identifies the correct window. If it does not, do the
following:
a. Open the application or browser window.
b. Drag a Window > Get active window title action above the Recorder > Capture action.
c. Insert a string variable into the Assign the window title to variable field.
d. Drag a Window > Set title action below the Window > Get active window title action.
e. In the Window field, insert the window variable generated by the Recorder > Capture action.
f. In the New window title field, insert the string variable from the Get active window title

action.
g. Щелкните Сохранить.

4. Необязательно: Select the Resize window option to specify the window dimensions.
This option delivers a more reliable бот. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the ботto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Прим.:  This option is available only for windows that can be resized. It is not available for the
Desktop or Taskbar options.

5. Browse to select the File path to save image.
The following file extensions are supported: png, bmp, jpeg, tiff, gif, and wmf.

6. Click Overwrite file to replace an existing file with the same name.
7. Щелкните Сохранить.

Service пакет
Use the Service пакет to automate operations in Windows and application services including starting,
stopping, pausing, resuming, or getting the status of services.

Прим.:  You must have administrator privileges to start, stop, pause, or resume service operations.

Действия в Службы пакет

пакет Службы включает в себя описанные ниже actions.
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Действие Описание

Получить состояние службы См. Get service status action in Службы

Приостановить службу См. Pause service action in Службы

Продолжить службу См. Resume service action in Службы

Запустить службу См. Start service action in Службы

Остановить службу See Stop service action in Службы.

Pause service action in Службы
The Pause service action in the Службы package enables you to pause a Windows or application service
that is currently running.

Настройки

Select the Service list or Variable option to enter the name of the service that you want to pause.

Resume service action in Службы
The Resume service action in the Службы enables you to resume a selected Windows or application
service that was previously paused.

Настройки

Select the Service list or Variable option to enter the name of the service that you want to resume the
services for.

Start service action in Службы
The Start service action in the Службы package enables you to start a selected Windows or application
service that is not running.

Настройки

Select the Service list or Variable option to enter the name of the service that you want to start the
service for.

Get service status action in Службы
The Get service status action in the Службы enables you to retrieve the current status of a Windows or
application service.

Настройки

• Select either the Service list or the Variable option and to enter the name of the service that you
want to get the status for.

• Select an appropriate variable that you can assign the status value to from the Assign the output to
an existing variable option.

Пример. The Windows Audio service status might be running.
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Stop service action in Службы
The Stop service action in the Службы package enables you to stop a selected Windows or application
service that is currently running.

Настройки

Select the Service list or Variable option to enter the name of the service that you want to stop the
service for.

ServiceNow пакет
ServiceNow is a leading software provider of digital work flows for enterprise operations. The Automation
360 ServiceNow command package uses the ServiceNow APIs to let you build and deploy bots in
Automation 360 that work with records and triggers in ServiceNow.
This package provides actions to authenticate with ServiceNow and perform several actions with records
and attachments. To perform these actions in ServiceNow, Automation 360 uses these APIs:
• Table API
• Attachment API

Automation 360 bots can increase process efficiency for these types of work flows: customer account
creation and management, customer verification, employee on-boarding and off-boarding, data extraction
and migration, and claims and invoice processing. Automation 360 helps extend the core work flow
capabilities of ServiceNow so that you can automate repetitive tasks for intelligent, end-to-end automation.
This Automation 360 command package enables Automation 360 bots and processes to use ServiceNow
API features natively within the Automation 360 platform.

ServiceNow Triggers

You can use the ServiceNow triggers to start Automation 360 bots to respond to the events in ServiceNow
such as incident creation, updates, and so on. For more information on ServiceNow triggers, see
ServiceNow New Record trigger and ServiceNow Updated Record trigger.
The following video shows the interaction between Automation 360 and ServiceNow when you use
ServiceNow command package:

Use cases

The key use cases for this package include:
• Create, read, update, and delete records from a ServiceNow table.
• Add, download, and delete attachments on ServiceNow records.
• Streamline Incident responses.
• Trigger specific automations from the creation of new Incidents or Incident updates.

Предварительные условия

• The bot creator must have access to a ServiceNow account with required permissions to perform tasks
enabled by this package. См. раздел Roles.
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• Follow ServiceNow guidelines for authenticating to external client with OAuth 2.0. См. раздел Setup
OAuth.

• Create a Developer account and Developer instance in ServiceNow. См. раздел Personal Developer
Instances.

Аутентификация
Use the Authentication and Revoke Authentication action to connect or disconnect from your
ServiceNow instance.
ServiceNow authentication action
Use the Authentication action to connect to your ServiceNow instance. After the authentication is
successful, you can use other command actions to perform various operations in ServiceNow.
• You must have the Client ID and Client secret generated in your ServiceNow instance. To generate the

Client details, see Create an OAuth API endpoint for external clients.
• You must have the Bot creator role for your Automation AnywhereControl Room to use the

ServiceNow package in a bot.

You can authenticate access to ServiceNow by retrieving the authentication parameters from the
ServiceNow instance and using them in Automation 360.
1. Log in to your ServiceNow instance.
2. Click All > Application Registry.
3. Select the OAuth you created.
4. Use the Client ID and Client Secret in your Authentication action from the Control Room.
5. Log in to the Control Room.
6. Create a new bot or edit an existing bot. See Создание первого бот.
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7. From the Actions pane, select ServiceNow > Authentication and place it under the start of the bot
flow.

Security Information Вариант

Client ID/Client secret/ User name/
Password

Select one of the following options to specify
the Client ID/Client secret/ ServiceNow
username/ password:
• Учетные данные. Enables you to

use a value in the Credential Vault that
contains information about the Client
ID/Client secret/ ServiceNow username/
password.

• Переменная. Enables you to use
a credential variable that contains
information about the Client ID/Client
secret/ ServiceNow username/ password.

• Insecure string: Enables you to enter
the Client ID/Client secret/ ServiceNow
username/ password for the ServiceNow
Authentication.

a) In the ServiceNow URL field, enter your ServiceNow instance URL.
b) (Optional) Enter the API version.
c) In the Client ID field, enter the Client ID copied from ServiceNow. In the example video below

an Insecure string is used, while you can use Credential or Variable options for better security.
d) In the Client Secret field, enter the Client Secret copied from ServiceNow.
e) Enter the ServiceNow user name.
f) Enter the ServiceNow password.
g) Enter Default as the Session name.
h) You can assign the authorization header to a variable by creating either a Multiple or Dictionary

variable.

8. Click Run to save and run your bot. Once authenticated, you can use the token to call other
ServiceNow API services.

ServiceNow revoke authentication action
Use the Revoke Authentication action to securely discard the refresh token and access token when you
do not need them anymore.

1. From the Actions pane, select ServiceNow > Authentication > Revoke Authentication and
place it under the bot flow.

2. Enter the session name and click Run.
3. After the bot runs, your ServiceNow access token is revoked.

Записи
Use the Records action to perform various operations in your ServiceNow instance. You can create,
update, delete, or get records from a ServiceNow Table.
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ServiceNow create record action
Use the Create Record action to create a new data record in the ServiceNow Table app.
• Ensure that you are authenticated before calling any ServiceNow action. For more details, see

ServiceNow authentication action.
• You must create a table in your ServiceNow instance as this action only creates a new record for an

existing table entry with the data provided. For more details, see Creating a table.

1. From the Actions pane, select ServiceNow > Records > Create Record and place it in the
canvas.
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2. Specify details in the following fields:
a) Enter the Table name. You can use a standard table name available in ServiceNow, for example:

Incident. Or you can use a custom user defined table name, for example: u_test_table.

Прим.:  For ServiceNow tables, ensure that you provide the Table name instead of the Label
name.

b) Enter the Fields and data to insert. Choose either Dictionary or Entry list. For this example,
Dictionary is selected.
1. Select the Type as String, Number, Datetime, or Boolean based on the data you want to insert

in the table.
2. Enter a key-value pair, where key is the ServiceNow field name and value is the data you

want to update in the field.

Прим.:  The key name for a field is different from the displayed label name. You can view
the key name of the file by using one of the following options:
• In your ServiceNow developer instance, navigate to System Definition > Language

File. You can use the filter option to view fields for specific Tables. Пример. Incident.
• Right-click on the field name (as shown below) to display the key name. For example:

caller_id is the key name for the field Caller.

c) Enter Default as the session name.
d) Save the record ID to a variable. For example, the record ID is saved to sys_id.

© 2023 Automation Anywhere. All rights reserved.     1863



    Automation Anywhere - Сборка

3. Click Run to save and run your bot.
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4. Verify whether the record is created in the ServiceNow table.
a) Find the sys_id variable value in the Debug mode.
b) Replace the ID in the ServiceNow URL (as shown below) to view the latest record created.

ServiceNow delete record action
Use the Delete Record action to delete a record from a ServiceNow table.
Ensure that you are authenticated before initiating any ServiceNow action. For more details, see
ServiceNow authentication action.

1. From the Actions pane, select ServiceNow > Records > Get Record and place it in the canvas.
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2. Specify details in the following fields:
a) Table name: Enter the ServiceNow table name.
b) Record Sys_id: Enter the sys_id of the record. If the record ID is captured in a variable, you can

provide the variable name.
c) The session name displays as Default.

3. Click Run to save and run your bot. When the bot is run successfully, your record in the ServiceNow
table is deleted.

ServiceNow get record action
Use the Get Record action to retrieve a record using the record ID stored in sys_Id variable from
ServiceNow.
Ensure that you are authenticated before initiating any ServiceNow action. For more details, see
ServiceNow authentication action.

1. From the Actions pane, select ServiceNow > Records > Get Record and place it in the canvas.
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2. Specify details in the following fields:
a) Table name: Enter the ServiceNow table name.
b) Record sys_id: Enter the sys_id of the record. If the record ID is captured in a variable you can

provide the variable name.
c) Select List for the Field names (Optional) field. Enter all the fields that you want to read.
d) The session name displays as Default.
e) Save the outcome to a variable. For example, the object ID is saved to dict_GetRecordResults.

3. Click Run to save and run your bot. When the bot is run successfully, the retrieved record is stored in
the specified variable.
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ServiceNow get multiple records action
Use the Get Multiple Records action to retrieve multiple records from a ServiceNow table.
Ensure that you are authenticated before initiating any ServiceNow action. For more details, see
ServiceNow authentication action.

1. From the Actions pane, select ServiceNow > Records > Get Multiple Records and place it in the
canvas.
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2. Specify details in the following fields:
a) Table name: Enter the ServiceNow table name.
b) Select List in the List of fields to return in the response (Optional) field. Enter the Type

and Value for the fields you want to view in the response.
c) You can optionally filter the records by using name-value pair or query. For example, select

Query and specify a query parameter to retrieve records for only the queried fields. For example,
you can map the sys_id to a variable and add it as a query.

d) Specify a limit of records to view. If the Limit field is blank or set to 0, all records are returned.
Response time might vary depending on the volume of the specified Table.

e) The session name displays as Default.
f) Save the outcome to a variable. For example, the object ID is saved to

list_GetMultipleRecordsResult.
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3. Click Run to save and run your bot. When the bot is run successfully, you will retrieve all the records
from ServiceNow.

ServiceNow update record action
Use the Update Record action to update a record in ServiceNow with name-value pairs.
Ensure that you are authenticated before initiating any ServiceNow action. For more details, see
ServiceNow authentication action.

1. From the Actions pane, select ServiceNow > Records > Get Record and place it in the canvas.
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2. Specify details in the following fields:
a) Table name: Enter the ServiceNow table name.
b) Sys_id: Enter the sys_id of the record. If the record ID is captured in a variable, you can provide

the variable name.
c) In Fields and data, select Dictionary or Entry list. In the example, Dictionary is selected and

the name-value pair is specified to update the record.
d) The session name displays as Default.
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3. Click Run to save and run your bot. When the bot is run successfully, your record is updated with the
specified details.

Вложения
Use the Attachments action to upload or delete an attachment from a record in the ServiceNow table. You
can also download an attachment from a ServiceNow record.
ServiceNow add attachment action
Use the Add Attachment action to add a new attachment to the specified record in a ServiceNow Table
app.
Ensure that you are authenticated before initiating any ServiceNow action. For more details, see
ServiceNow authentication action.

1. From the Actions pane, select ServiceNow > Attachments > Add Attachment and place it in the
canvas.

© 2023 Automation Anywhere. All rights reserved.     1873



    Automation Anywhere - Сборка

2. Specify details in the following fields:
a) Enter the Table name.

Прим.:  For ServiceNow tables, ensure that you provide the Table name instead of the Label
name.

b) Select the File to be uploaded by using one of the following options:
• Control Room file: If the file exists within the Control Room folders, select this option.
• Desktop file: If the file exists in your local system desktop, select this option and browse the

file path.
• Переменная. You can also store the file path as a variable.

Прим.:  Maximum size of the file to upload cannot exceed 25 MB.

c) (Optional) You can enter a name in the New file name field.
d) The session name displays as Default.
e) You can assign the attachment ID to a string variable. For example, the attachment ID is saved to

str_AttachmentSysId.
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3. Click Run to save and run your bot.
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4. Verify whether the attachment is added in the ServiceNow record as shown below:

ServiceNow delete attachment action
Use the Delete Attachment action to delete an attachment from a ServiceNow record.
Ensure that you are authenticated before initiating any ServiceNow action. For more details, see
ServiceNow authentication action.

1. From the Actions pane, select ServiceNow > Attachments > Delete Attachment and place it in
the canvas.
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2. Specify details in the following fields:
a) Sys_id: Enter the attachment ID or select the variable where you stored the attachment ID.
b) The session name displays as Default.

3. Click Run to save and run your bot. When the bot is run successfully, your attachment in the
ServiceNow record is deleted.

ServiceNow get attachment action
Use the Get Attachment action to download a new attachment from the specified record in a ServiceNow
Table app.
Ensure that you are authenticated before initiating any ServiceNow action. For more details, see
ServiceNow authentication action.

1. From the Actions pane, select ServiceNow > Attachments > Get Attachment and place it in the
canvas.
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2. Specify details in the following fields:
a) Filter attachment by.

• Sys_id: Specify the attachment ID or select a variable where the attachment ID is stored.
• Associated record: Specify details of the associated record, to download the associated

attachment. You must enter the table name and the table ID.
• Query: Specify a query parameter to download the attachments. For example, you can map

the sys_id to a variable and add it as a query.

b) Enter a Destination folder path, or select a variable if the path is stored in a variable.
c) The session name displays as Default.
d) You can assign the attachment ID to a string variable. For example, the attachment ID is saved to

list_GetAttachmentResults.

3. Click Run to save and run your bot.
4. The attachment is downloaded to the specified folder path.

ServiceNow field types: Table API
The ServiceNow schema contains various fields that you can modify by using the Automation 360
ServiceNow command package. The following table lists alphabetically the supported field types and their
corresponding Automation 360 to ServiceNow actions.
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Field Type Create / Update Record Get Record

Audio Not supported Supported

Choice Supported Supported

Collection Not supported Not supported

Color Supported Supported

Condition String Limited support Supported

Conditions Supported Supported

Currency Supported Supported

Data Structure Supported Supported

Дата Supported Supported

Date/Time Supported Supported

Decimal Supported Supported

Document ID Supported Supported

Domain ID Supported Supported

Due Date Supported Supported

Duration Supported Supported

Field Name Supported Supported

File Attachment Not Supported Supported

Floating Point Number Supported Supported

FX Currency Supported Supported

HTML Supported Supported

Icon Supported Supported

Image Not Supported Supported

Integer Supported Supported

IP address Supported Supported

Journal Supported Supported

Journal Input Supported Supported
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Field Type Create / Update Record Get Record

Journal List Supported Supported

Список Supported Supported

Long Supported Supported

Name-Value Pairs Supported Supported

Password (1 Way
Encrypted)

Supported Supported

Password (2 Way
Encrypted)

Supported Supported

Percent Complete Supported Supported

Phone Number (E164) Supported Supported

Price Supported Supported

Reference Supported Supported

Script Not Supported Supported

Script (Plain) Supported Supported

String Supported Supported

String (Full UTF-8) Supported Supported

Suggestion Supported Supported

Sys ID Supported Supported

Table Name Supported Supported

Время Supported Supported

Translated HTML Supported Supported

Translated Text Supported Supported

True/False Supported Supported

URL Supported Supported

Video Not Supported Supported

Wiki Not Supported Supported

Workflow Supported Supported
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Имитация нажатия клавиш пакет
Use the Имитация нажатия клавиш пакет to simulate keystrokes in Chinese (simplified and traditional),
English, French, German, Japanese, Korean, Italian, or Spanish characters.

Automation 360 extension setting

If the бот execution takes longer when you use the Имитация нажатия клавиш пакетto simulate
keystrokes in a static page running on the Google Chrome or Microsoft Edge browser, then follow these
steps to enable the setting in the Automation 360 extension:
• Click the extensions icon at the top right corner of the browser window.
• Click the vertical ellipses next to the  plugin and select Manage extension.
• Enable the Allow access to file URLs option.
• Restart the browser and run the .

Действие в Имитация нажатия клавиш пакет

пакет Имитация нажатия клавиш включает в себя описанные ниже action.

Действие Описание

Нажатия клавиш См. раздел Using Keystrokes action.

Задачи, связанные с данной
Build a basic бот that uses a desktop application
Build a бот that uses a conditional statement to verify that the calculator is open, then uses the calculator
to multiply two numbers. This example uses actions from the Приложение, Если, Имитация нажатия
клавиш, Message Box, and Окно пакеты.

Using Keystrokes action
Use the Keystrokes action to simulate keystrokes.
Follow these steps to add a Keystrokes action:
1. In the Действия palette, double-click or drag the Keystrokes action from the Keystrokes пакет.
2. Specify the window in which to capture an object.

Choose from the Application, Browser, or Variable tab.
Вариант Описание

Приложение Select from a list of currently active windows.
This option shows a list of all the application
and browser windows that are open on the Bot
Creator device.

Браузер Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based
, and  browsers. For all other browsers, use the
Application option.
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Вариант Описание

Переменная Выберите существующую переменную окна,
чтобы задать заголовок в заголовке окна
приложения.

Вставьте символ подстановочного знака (*) в поле Заголовок окна для поиска заголовков окон,
которые могут меняться. You can specify one or more wildcards (*) at the start, middle, or end of
the value.For example, to perform an operation on any window that has Microsoft in the title, use a
wildcard to indicate any string by adding it before or after the value: *Microsoft*. The  first searches
for the exact window title (Microsoft), and if it does not find a match, it searches for windows with the
term Microsoft anywhere in the title.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна. Select
the regular expression condition as either String or a Pattern and then enter the value. By default, the
Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or disable
the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released with 
v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be identified
only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those window
titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window title

in any , the  might encounter a run time error. To prevent the run time error, ensure that when you add
the string input as *-title, the application with the specific title is open. The asterisk (*) is just a
character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window title
in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

3. Необязательно: Select the Resize window option to specify the window dimensions.
This option delivers a more reliable бот. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the ботto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Прим.:  This option is available only for windows that can be resized. It is not available for the
Desktop or Taskbar options.
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4. In the Keystrokes, select a radio button:
• Enter keystrokes here or use the on-screen keyboard: Type or use the keyboard to enter

keystrokes.
• Select a credential: Uses a password stored in the Credential Vault.

Прим.:  A new key named Return has been added to the virtual keyboard to replace the Enter
functionality and the Enter key in the Number pad has been renamed to Num Enter. As a result, the
Return key is the main Enter key on the keyboard.

5. Необязательно: : In the Delay between each keystroke in ms field, the delay time.

Прим.:  The default is set to 10 milliseconds.

6. Щелкните Сохранить.

SNMP пакет
The SNMP пакет allows you to automate network management tasks, such as retrieving and modifying
data, and sending notification messages.
Simple Network Management Protocol (SNMP) is used to find the network management component on one
or more computers and the managed component on multiple network devices.
The Automation Anywhere SNMP action offers powerful network management. Using this action, users can
easily monitor network devices configured with SNMP agent software. Network devices such as servers,
workstations, printers, routers, bridges, and hubs, as well as services such as Dynamic Host Configuration
Protocol (DHCP) or Windows Internet Name Service (WINS) can be monitored.

Действия в SNMP пакет
пакет SNMP включает в себя описанные ниже actions.

Действие Описание

Получить См. Get action

Получить следующее См. Get next action

Отправить ловушку См. Send trap action

Установить См. Задать action

Обход См. Задать action

Ссылки, связанные с данной
Active Directory пакет
Use the Active Directory пакет to automate actions in the Active Directory. An Active Directory is
a directory service provided by Microsoft to assist the admin in managing users across a group or
organization.
Принтер пакет
Use the actions in the Принтер пакет to automate retrieving and setting the default printer and removing
a printer from the list of available printers.
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Get action
Use the Get action in the SNMP пакет to retrieve data of an object that is managed by SNMP agent.
1. In the Действия palette, double-click or drag the Get action from the SNMP пакет.
2. In the Agent field, enter details of the device on which the SNMP agent is available.
3. Click the SNMP Version drop-down menu to select one of the following options to specify the SNMP

version that must be used:
Вариант Действие

V1 Specify the community string you want to use in
the Community field.

V2C Specify the community string you want to use in
the Community field.
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Вариант Действие

V3 Specify the community string you want to use in
the Community field.
Click the Authentication level drop-down
menu to specify one of the following level of
authentication:
• None: Authentication will not be used.
• Authentication Only: Enables you to use

authentication only.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Учетные данные. To use a value

from the Credential Vault.
(Optional) Click Pick to choose a
credential.

• Переменная. To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

• Authentication and privacy: Enables you
to use authentication and privacy.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Учетные данные. To use a value

from the Credential Vault.
(Optional) Click Pick to choose a
credential.

• Переменная. To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

c. Click Privacy method drop-down menu
and select DES or AES to specify the
privacy method you want to use.

d. In the Private key field, click one of the
following tabs:
• Учетные данные. To use a value

from the Credential Vault.
(Optional) Click Pick to choose a
credential.

• Переменная. To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.
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4. In the Object ID field, specify the ID of the object for which you want to retrieve details.
5. Use the Data type field to select one of the following options to specify the format in which you want

to retrieve details of the object:
• ASCII
• Hex

6. Click the SNMP advanced options drop-down menu and enter the values in the following fields:
• Timeout(ms): Specify the time (in milliseconds) for the action to wait before generating an error.
• Remote port: Specify the port number of the remote device.
• Retries: Specify the maximum number of times the action must try to retrieve the details.

7. In the Log file field, click one of the following tabs:
• Control Room file: To select a file that is available on the Control Room to store the result.

Click Choose to select a file.
• Desktop file: To select a file that is available on a device to store the result.

Click Browse to locate and select a file.
• Переменная. To select a variable by specifying the file location that you want to use to store the

result.

8. Select a string variable from the Assigned to list.
9. Щелкните Сохранить.

Get next action
Use the Get next action in the SNMP пакет to retrieve data of the next object that is managed by an
SNMP agent.
1. In the Действия palette, double-click or drag the Get next action from the SNMP пакет.
2. In the Agent field, enter details of the device on which the SNMP agent is available.
3. Click the SNMP Version drop-down menu to select one of the following options to specify the SNMP

version that must be used:
Вариант Действие

V1 Specify the community string you want to use in
the Community field.

V2C Specify the community string you want to use in
the Community field.
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Вариант Действие

V3 Specify the community string you want to use in
the Community field.
Click the Authentication level drop-down
menu to specify one of the following level of
authentication:
• None: Authentication will not be used.
• Authentication Only: Enables you to use

authentication only.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Учетные данные. To use a value

from the Credential Vault.
(Optional) Click Pick to choose a
credential.

• Переменная. To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

• Authentication and privacy: Enables you
to use authentication and privacy.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Учетные данные. To use a value

from the Credential Vault.
(Optional) Click Pick to choose a
credential.

• Переменная. To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

c. Click Privacy method drop-down menu
and select DES or AES to specify the
privacy method you want to use.

d. In the Private key field, click one of the
following tabs:
• Учетные данные. To use a value

from the Credential Vault.
(Optional) Click Pick to choose a
credential.

• Переменная. To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.
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4. In the Object ID field, specify the ID of the object for which you want to retrieve details.
5. Use the Data type field to select one of the following options to specify the format in which you want

to retrieve details of the object:
• ASCII
• Hex

6. Click the SNMP advanced options drop-down menu and enter the values in the following fields:
• Timeout(ms): Specify the time (in milliseconds) for the action to wait before generating an error.
• Remote port: Specify the port number of the remote device.
• Retries: Specify the maximum number of times the action must try to retrieve the details.

7. In the Log file field, click one of the following tabs:
• Control Room file: To select a file that is available on the Control Room to store the result.

Click Choose to select a file.
• Desktop file: To select a file that is available on a device to store the result.

Click Browse to locate and select a file.
• Переменная. To select a variable by specifying the file location that you want to use to store the

result.

8. Select a string variable from the Assigned to list.
9. Щелкните Сохранить.

Send trap action
Use the Send trap action in the SNMP пакет to send messages to the SNMP manager from an SNMP
agent. These messages are sent by an SNMP agent whenever certain events occur, such as a system
restart.
1. In the Действия palette, double-click or drag the Send trap action from the SNMP пакет.
2. In the Agent field, enter details of the device on which the SNMP agent is available.
3. Click the SNMP Version drop-down menu to select one of the following options to specify the SNMP

version that must be used:
Вариант Действие

V1 Specify the community string you want to use in
the Community field.

V2C Specify the community string you want to use in
the Community field.
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Вариант Действие

V3 Specify the community string you want to use in
the Community field.
Click the Authentication level drop-down
menu to specify one of the following level of
authentication:
• None: Authentication will not be used.
• Authentication Only: Enables you to use

authentication only.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Учетные данные. To use a value

from the Credential Vault.
(Optional) Click Pick to choose a
credential.

• Переменная. To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

• Authentication and privacy: Enables you
to use authentication and privacy.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Учетные данные. To use a value

from the Credential Vault.
(Optional) Click Pick to choose a
credential.

• Переменная. To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

c. Click Privacy method drop-down menu
and select DES or AES to specify the
privacy method you want to use.

d. In the Private key field, click one of the
following tabs:
• Учетные данные. To use a value

from the Credential Vault.
(Optional) Click Pick to choose a
credential.

• Переменная. To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.
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4. In the Object ID field, specify the ID of the object for which you want to retrieve details.
5. Необязательно: In the Authorative ID field, specify the ID of the SNMP manager that will receive

the notification.

Важное замечание:  If you have selected V3 from the SNMP Version list, you must provide a
value for Authorative ID.

6. Select an option from the Select trap type list to specify the type of trap you want to send.
• Cold start: Occurs when the SNMP agent initializes its configuration tables.
• Warm start: Occurs when the SNMP agent reinitializes its configuration tables.
• Link down: Occurs when the state of a network adapter on the SNMP agent changes from up to

down.
• Link up: Occurs when the state of a network adapter on the SNMP agent changes from down to

up.
• Authentication fail: Occurs when the SNMP agent receives a message from an SNMP manager

with an invalid community name.
• EGP neighbour loss: Occurs when the SNMP agent cannot communicate with its Exterior

Gateway Protocol (EGP) peer.
• Enterprise specific: Occurs when specific error conditions and error codes are defined in the

system. The user provides a trap-specific number for this option.

7. Click the SNMP advanced options drop-down menu and enter the values in the following fields:
• Timeout(ms): Specify the time (in milliseconds) for the action to wait before generating an error.
• Remote port: Specify the port number of the remote device.
• Retries: Specify the maximum number of times the action must try to retrieve the details.

8. In the Log file field, click one of the following tabs:
• Control Room file: To select a file that is available on the Control Room to store the result.

Click Choose to select a file.
• Desktop file: To select a file that is available on a device to store the result.

Click Browse to locate and select a file.
• Переменная. To select a variable by specifying the file location that you want to use to store the

result.

9. Щелкните Сохранить.

Задать action
Use the Set action in the SNMP пакет to set a value for an object managed by the SNMP agent.
1. In the Действия palette, double-click or drag the Set action from the SNMP пакет.
2. In the Agent field, enter details of the device on which the SNMP agent is available.
3. Click the SNMP Version drop-down menu to select one of the following options to specify the SNMP

version that must be used:
Вариант Действие

V1 Specify the community string you want to use in
the Community field.

V2C Specify the community string you want to use in
the Community field.
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Вариант Действие

V3 Specify the community string you want to use in
the Community field.
Click the Authentication level drop-down
menu to specify one of the following level of
authentication:
• None: Authentication will not be used.
• Authentication Only: Enables you to use

authentication only.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Учетные данные. To use a value

from the Credential Vault.
(Optional) Click Pick to choose a
credential.

• Переменная. To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

• Authentication and privacy: Enables you
to use authentication and privacy.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Учетные данные. To use a value

from the Credential Vault.
(Optional) Click Pick to choose a
credential.

• Переменная. To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

c. Click Privacy method drop-down menu
and select DES or AES to specify the
privacy method you want to use.

d. In the Private key field, click one of the
following tabs:
• Учетные данные. To use a value

from the Credential Vault.
(Optional) Click Pick to choose a
credential.

• Переменная. To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

© 2023 Automation Anywhere. All rights reserved.     1891



    Automation Anywhere - Сборка

4. In the Object ID field, specify the ID of the object for which you want to retrieve details.
5. From the Value type list, select an option to specify the value you want to set.

• OctetString
• Integer
• Gauge
• TimeTicks
• IP
• ObjectID
• OctetByteString
• OctetDecimalByteString
• NULL

6. In the Set value field, specify the value you want to set.
7. Click the SNMP advanced options drop-down menu and enter the values in the following fields:

• Timeout(ms): Specify the time (in milliseconds) for the action to wait before generating an error.
• Remote port: Specify the port number of the remote device.
• Retries: Specify the maximum number of times the action must try to retrieve the details.

8. In the Log file field, click one of the following tabs:
• Control Room file: To select a file that is available on the Control Room to store the result.

Click Choose to select a file.
• Desktop file: To select a file that is available on a device to store the result.

Click Browse to locate and select a file.
• Переменная. To select a variable by specifying the file location that you want to use to store the

result.

9. Щелкните Сохранить.

Walk action
Use the Walk action in the SNMP пакет to set up a collection of information about all the devices available
on all the connected nodes or subtree.
1. In the Действия palette, double-click or drag the Walk action from the SNMP пакет.
2. In the Agent field, enter details of the device on which the SNMP agent is available.
3. Click the SNMP Version drop-down menu to select one of the following options to specify the SNMP

version that must be used:
Вариант Действие

V1 Specify the community string you want to use in
the Community field.

V2C Specify the community string you want to use in
the Community field.
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Вариант Действие

V3 Specify the community string you want to use in
the Community field.
Click the Authentication level drop-down
menu to specify one of the following level of
authentication:
• None: Authentication will not be used.
• Authentication Only: Enables you to use

authentication only.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Учетные данные. To use a value

from the Credential Vault.
(Optional) Click Pick to choose a
credential.

• Переменная. To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

• Authentication and privacy: Enables you
to use authentication and privacy.
a. Select MD5 or SHA from the

Authentication method list to specify
the authentication method you want to
use.

b. In the Password field, click one of the
following tabs:
• Учетные данные. To use a value

from the Credential Vault.
(Optional) Click Pick to choose a
credential.

• Переменная. To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.

c. Click Privacy method drop-down menu
and select DES or AES to specify the
privacy method you want to use.

d. In the Private key field, click one of the
following tabs:
• Учетные данные. To use a value

from the Credential Vault.
(Optional) Click Pick to choose a
credential.

• Переменная. To use a credential
variable.

• Insecure string: To manually specify
the value you want to use.
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4. In the Object ID field, specify the ID of the object for which you want to retrieve details.
5. Use the Data type field to select one of the following options to specify the format in which you want

to retrieve details of the object:
• ASCII
• Hex

6. In the Walk type section, select an option to specify the scope from which to collect information.
• Все. Displays the variables that are equal to the specified OID for the given tree type structure.
• Within: All variables in the sub-tree below the given OID are queried.

7. Click the SNMP advanced options drop-down menu and enter the values in the following fields:
• Timeout(ms): Specify the time (in milliseconds) for the action to wait before generating an error.
• Remote port: Specify the port number of the remote device.
• Retries: Specify the maximum number of times the action must try to retrieve the details.

8. In the Log file field, click one of the following tabs:
• Control Room file: To select a file that is available on the Control Room to store the result.

Click Choose to select a file.
• Desktop file: To select a file that is available on a device to store the result.

Click Browse to locate and select a file.
• Переменная. To select a variable by specifying the file location that you want to use to store the

result.

9. Select a string variable from the Assigned to list.
10. Щелкните Сохранить.

Веб-служба SOAP пакет
Use the SOAP web service action from the Веб-служба SOAP пакет to access and exchange information
between two systems in XML format.
With SOAP Web Service, you can perform these actions:
• Consume SOAP web services written to provide structured data for further business processing, such as

currency conversion, weather reports, and language translation.
• Connect to different existing applications and different platforms, irrespective of any underlying

infrastructure requirements.

The SOAP Web Service establishes complete interoperability between clients or applications and the
internet, supporting XML-based open standards, such as Web Services Description Language (WSDL),
Simple Object Access Protocol (SOAP), and Universal Description Discovery and Integration (UDDI).

Безопасная передача значений

Вы можете безопасно передавать значения из Credential Vault в веб-службу, указав учетные данные
ячейка и атрибут в следующих поддерживаемых полях action.
• Настраиваемые заголовки
• Параметры операции
• Raw data: You must select a Credential Vault value that contains the entire parameter as the value.
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Поддержка прокси-сервера

Если ваше устройство настроено на использование прокси-сервера, все исходящие запросы
пакет будут направляться через прокси-сервер. См. раздел Подключение Bot Agent к устройству с
использованием прокси-сервера.

Прим.:  For an example task about using the Веб-служба SOAP action, see Пример использования
действия веб-службы SOAP.

Задачи, связанные с данной
Example of building a бот that uses credential variables
Securely pass values to a бот using credential variables to automate the process of logging in to a bank
website.
Ссылки, связанные с данной
Credentials and credential variables in the Bot editor
Use credentials when building боты to pass sensitive information such as passwords and account numbers.
Using credentials separates the sensitive information from the боты and Bot Runner, which reduces the
risk of data spillage or unauthorized user access.

Шаг пакет
The Шаг пакет groups various actions together and runs them in a specific order. You can provide a
relevant name for a step to identify the operation performed by the actions included in that step.

Действие в Шаг пакет

пакет Шаг включает в себя указанные ниже action.

Действие Описание

Шаг Runs a sequence of actions.
• Creates a container for actions without impacting the бот run.
• Configures actions within the Шаг action.
• Runs the arranged actions in a sequential order.
• Groups various actions for better management.
• Optional: In the Title field, specify the title.

Строка пакет
Use the Строка пакет to perform various operations such as comparing two strings, retrieving the string
length, or converting a string to uppercase or lowercase.

Действия в Строка пакет

пакет Строка включает в себя указанные ниже actions.

Действие Описание

Присвоить Assign action
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Действие Описание

Извлечь текст Using Extract text action of Строка пакет

Сравнить Compare action

Оценить переменную Evaluate variable action

Найти Using Find action of Строка пакет

Длина Length action

Нижний регистр Lowercase action

Создать случайную
строку

Generate random string action

Заменить Using Replace action

Обратный порядок Reverse action

Разделить Using Split action

Подстрока Substring action

В логическое
значение

To boolean action

К номеру региона To locale number action

В число To number action

Обрезать Trim action

Верхний регистр Uppercase action

Импортировать
строку из текстового
файла

Import string from text file action

Задачи, связанные с данной
Using Extract text action of Строка пакет
Используйте action Извлечь текст для извлечения диапазона текста с помощью логических
операторов из исходной строки.
Using Find action of Строка пакет
Use the Find action to find a substring within the specified string.
Using Replace action
Use the Replace action to find a piece of text from the source string and replace it with another text.
Using Split action
Use the Split action to split the specified string into multiple strings and store the output in a list variable.

Assign action
The Assign action in the Строка пакет enables you to assign or concatenate strings.
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Настройки

• Необязательно. In the Select the source string variable(s)/value field, specify the variable or
values. This field holds up to 65535 alphanumeric, character, and empty values.

Прим.:
• Чтобы предоставить строку, которая содержит знак доллара ($), необходимо ввести два знака

доллара. For example, if you enter Pay $$5.00, the output will be Pay $5.00.
• The values or variables that you can specify for the String пакет are predefined. См.

Предварительно определенные переменные

• In the Select the destination string variable field, specify the variable.

Using Extract text action of Строка пакет
Используйте action Извлечь текст для извлечения диапазона текста с помощью логических
операторов из исходной строки.
Review the information in Извлечь текст.
Чтобы извлечь подстроку из указанной исходной строки, выполните следующие действия.
1. На палитре Действия дважды щелкните или перетащите action Извлечь текст из пакет

Строка.
2. В поле Исходная строка укажите исходную строку.
3. Укажите текст для извлечения, выбрав один из следующих параметров.

Вариант Шаги

До Извлекает весь текст, за которым следует значение, указанное в поле
Начать после текста.
a. В поле Начать после текста введите строку, которую следует

использовать в качестве начальной точки.
b. В поле Периодичность введите значение, чтобы указать

количество повторений.
Например, если исходная строка имеет вид This is a test
 string which is used to extract specific sub-
string и вы хотите извлечь весь текст после This. Чтобы
извлечь требуемый текст, необходимо ввести This в поле
Начать после текста и 1 в поле Периодичность. Это
указывает системе извлечь текст, который доступен после
первого появления This в исходной строке.
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Вариант Шаги

До и (или) после Извлекает текст между значениями, указанными в полях Начать
после текста и Завершить до текста.
a. В поле Начать после текста введите строку, которую следует

использовать в качестве начальной точки.
b. В поле ИЛИ или И выберите один из параметров.

• ИЛИ. Выберите этот вариант для извлечения текста, если
одно из значений, указанных в поле Начать после текста
или Завершить до текста, имеется в исходной строке.

• И. Выберите этот вариант для извлечения текста, если
оба значения, указанные в полях Начать после текста и
Завершить до текста, имеются в исходной строке.

c. В поле Завершить до текста укажите строку, которую следует
использовать в качестве конечной точки при извлечении текста.

d. В поле Периодичность введите значение, чтобы указать
количество появлений строки, которую вы указали в поле
Завершить до текста.
Например, если исходная строка имеет вид This is a
 test string which is used to extract specific
 substring и вы хотите извлечь весь текст до specific.
Чтобы извлечь требуемый текст, необходимо ввести specific
в поле Завершить до текста и 1 в поле Периодичность. Это
указывает системе извлечь текст, который доступен до первого
появления specific в исходной строке.

После Извлекает весь текст, предшествующий значению, которое вы
указали в поле Завершить до текста.
a. В поле Завершить до текста укажите строку, которую следует

использовать в качестве конечной точки при извлечении текста.
b. В поле Периодичность введите значение, чтобы указать

количество появлений строки, которую вы указали в поле
Завершить до текста.
Например, если исходная строка имеет вид This is a
 test string which is used to extract specific
 substring и вы хотите извлечь весь текст до specific.
Чтобы извлечь требуемый текст, необходимо ввести specific
в поле Завершить до текста и 1 в поле Периодичность. Это
указывает системе извлечь текст, который доступен до первого
появления specific в исходной строке.

4. В поле Если совпадений нет, вернуть выберите один из параметров.
• Исходная строка. Возврат исходной строки.
• Пустая строка (null). Возврат пустой строки, если совпадение не найдено.
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5. В поле При извлечении выберите один из следующих параметров.
• С учетом регистра. Сопоставляет регистр текста в исходной строке
• Без учета регистра. Не сопоставляет регистр текста в исходной строке

Прим.:  По умолчанию выбран параметр С учетом регистра для всех новых и существующих
боты.

6. В поле Число символов, которые требуется получить выберите один из параметров.
• Все. Извлекает все символы из исходной строки.
• Только. Укажите количество символов для извлечения из исходной строки.

7. Установите флажок Обрезать извлеченный текст (удалить пробелы), чтобы удалить
пробелы из извлеченного текста.

8. Установите флажок Удалить Enter из извлеченного текста, чтобы удалить возвраты каретки
из извлеченного текста.

9. В списке Присвоить выходные данные переменной укажите переменную.
10. Щелкните Сохранить.

Извлечь текст
The Extract text action enables you to extract text from a source string. You can extract text that occurs
in the range of 1 to 999999 times in a file before, after, or between two strings.

Using the After Option

This option enables you to extract the entire text followed by the value you have provided in the Start
after text field. You can also extract the text based on the occurrence of the value you have provided in
the field.
For example, a:123a:123b:123c: is the source string, you can specify ':' in the Start after text field
and '2' in the Occurrence field to extract the string followed by the second occurrence of ':' in the source
string. In this example, the extracted text is '123b:123c:'.

Using the Before Option

This option enables you to extract the entire text preceding the value you have provided in the End
before text field. You can also extract the text based on the occurrence of the value you have provided in
the field.

Прим.:  You can extract text that occurs more than 1000 times in a file and up to a maximum of 999999
times.

For example, a:123a:123b:123c: is the source string, you can specify ':' in the End before text field
and '3' in the Occurrence field to extract the string preceding the third occurrence of ':' in the source
string. In this example, the extracted text is 'a:123a:123b'.

Using the Before and/or after option

This option enables you to extract the text between the values you have provided in the Start after text
and the End before text fields. You can also apply the AND or OR logical operator. You can select the
AND operator to extract text only when both conditions specified for the Before and After options are
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satisfied. Otherwise, you can select the OR operator to extract text only when either of the conditions
specified for the Before or the After option is satisfied.
For example, a:123a:123b:123c: is the source string, you can specify ':' in the Start after text and
End before text fields and '2' in the Occurrence fields to extract the string after the second and before
the fourth occurrence of ':' in the source string. In this example, the extracted text is '123b:123c'.

Compare action
The Compare action in the Строка пакет enables you to compare two strings.

Настройки

• In the Source string field, specify the source string.
• In the Compare to string field, specify the string that the source has to be compared with.
• In the When comparing field, select an option:

• С учетом регистра. Matches capitalization.
• Без учета регистра. Does not match capitalization.

• In the Assign the output to variable list, specify the Boolean variable.

Evaluate variable action
The Evaluate variable action in the Строка пакет enables you to compare the user-specified string
variable with the string variables in the бот and if a match is found, the action returns the value of the
matching variable.

Настройки

• Enter the string variable to search for.
• In the Assign the value to a variable field, select a string variable to hold the returned value.

Пример.
1. Create a variable of type string whose value you want to evaluate and name it var1. Here the value

of the variable var1 is $cityname$ and $cityname$ has the value Paris.
2. Enter $var1$ in the Variable expression field.
3. On бот execution, the user specified string variable $var1$ now searches among the variables

defined in the бот for the string variable $cityname$ and if the match is found then the action
returns the output value of the matched variable $cityname$, that is, Paris.

Прим.:  This action can evaluate only string variables and up to one level of nesting.

Using Find action of Строка пакет
Use the Find action to find a substring within the specified string.
This action also enables you to perform a search based on a regular expression. A regular expression
is a sequence of characters that define a search pattern. For example, to find all email addresses in the
source string, specify the following as a regular expression: \b[A-Z0-9._%-]+@[A-Z0-9.-]+\.[A-Z]
{2,4}\b.
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Прим.:  To search for strings that contain the dollar sign ($), you must enter the sign twice. Otherwise,
the бот interprets the dollar sign as a regular expression character.

To find a substring from the specified string, follow these steps:
1. In the Действия palette, double-click or drag the Find action from the String пакет.
2. В поле Исходная строка укажите исходную строку.
3. In the Find string field, specify the substring.
4. In the When finding field, select one of the options:

• С учетом регистра. Matches the case of the text.
• Без учета регистра. Does not match the case of the text.

5. In the The "find string" is field, select one of the options:
• A regular expression: The substring is a regular expression
• Not a regular expression: The substring is not a regular expression.

6. Необязательно: In the Start from field, specify the starting point.
For example, you want to replace Red in the source string with Blue in a paragraph. Red is in 10
instances in the paragraph and you want to replace only the third occurrence. Enter 3 in the Start
from field to identify the third occurrence.

7. In the Assign the output to variable list, specify the number variable.
8. Щелкните Сохранить.

Length action
The Length action in the Строка пакет enables you to retrieves the string length.

Настройки

• In the Source string field, specify the source string.
• In the Assign the output to variable list, specify the number variable.

Lowercase action
The Lowercase action in the Строка пакет enables you to convert the source string to lowercase.

Настройки

• In the Source string field, specify the source string.
• In the Assign the output to variable list, specify the variable.

Generate random string action
The Generate random string action in the Строка пакет enables you to generate a string of uppercase
and lowercase alphanumeric characters and assign it to a string variable.

Настройки

• In the String length field, enter the number of characters in the generated string.
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Прим.:  The maximum number of characters is 300.

• In the Enter the destination variable to assign the random string field, specify the string
variable.

Using Replace action
Use the Replace action to find a piece of text from the source string and replace it with another text.
A regular expression is a sequence of characters that define a search pattern. For example, to find all email
addresses in the source string, specify the following as a regular expression: \b[A-Z0-9._%-]+@[A-
Z0-9.-]+\.[A-Z]{2,4}\b.

Прим.:  The Replace action might not replace the Carriage Return and Line Feed (CRLF) characters in
a string when you use the Enter variable. To ensure that the characters are replaced, instead of the Enter
variable, use the Newline variable.

To replace text from the specified string, follow these steps:
1. In the Действия palette, double-click or drag the Replace action from the String пакет.
2. В поле Исходная строка укажите исходную строку.
3. In the Find string field, specify the substring.
4. In the When finding field, select one of the options:

• С учетом регистра. Matches the case of the text.
• Без учета регистра. Does not match the case of the text.

5. In the The "find string" is field, select one of the options:
• A regular expression: The substring is a regular expression
• Not a regular expression: The substring is not a regular expression.

6. Необязательно: In the Start from field, specify the starting position.
The action then starts from the value you specify in this field. For example, if you specify 5 in the
Start from field for the source string "Big blue ocean", when the bot runs, the action ignores the four
preceding characters ("Big", including the space character) and searches for the substring in "blue
ocean".

7. Необязательно: In the Count field, specify the number of times the found string must be replaced.
For example, in the source string "Big blue ocean, blue fish, blue sky", you want to replace the first
two instances of "blue" with "green". Enter 2 in the Count field, 5 in the Start from field, and green
in the Replace with field. When the бот runs, the action produces the output green ocean,
 green fish, blue sky.

Прим.:  By default, the value in the Count field is set to -1, which means that all the instances of the
found string will be replaced.

8. In the Replace with field, specify the text to replace the string.
9. In the Assign the output to variable list, specify the variable that will hold the new string.
10. Щелкните Сохранить.

Reverse action
The Reverse action in the Строка пакет enables you to reverse the source string.
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Настройки

• In the Source string field, specify the source string.
• В списке Присвоить выходные данные переменной укажите переменную.

Using Split action
Use the Split action to split the specified string into multiple strings and store the output in a list variable.
To split a string into multiple strings, perform these steps:
1. In the Действия palette, double-click or drag the Split action from the String пакет.
2. В поле Исходная строка укажите исходную строку.
3. In the Delimiter field, specify the character to split the string.

For example, comma (,), semicolon (;), pipe (|), slash (/ \), newline character (\n), or space.
In the delimiter text box, the newline character is not accepted for the Enter key as a line break.
In that case, you can either press F2 and select Enter - String from String section or input the
$String:Enter$ variable.

4. In the Delimiter is field, select one of the options:
• Case sensitive: The delimiter is case-sensitive.
• Not case sensitive: The delimiter is not case-sensitive.

5. In the Split into substrings field, select one of the options:
• All possible: Splits the source string into as many substrings as possible.

For example, if the original string is a,b,c,d, each character becomes a substring.
• Только. Limits the number of substrings.

For example, if the original string is a,b,c,d, and you enter 3, the output is three strings: a, b, and
c,d.

6. In the Assign the output to list variable field, specify the list variable.
7. Щелкните Сохранить.

Substring action
The Substring action in the Строка пакет enables you to extract a substring from a string.

Настройки

• In the Source string field, specify the source string.
• In the Start from field, specify the starting point.
• Необязательно. In the Length field, specify the length.
• В списке Присвоить выходные данные переменной укажите переменную.

To boolean action
The To boolean action in the Строка пакет enables you to convert a string to a Boolean.
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Настройки

• In the Select string variable variable field, specify the source string variable.
• In the Select the boolean variable to store the result field, specify the Boolean variable.

To locale number action
The To locale number action in the Строка пакет enables you to convert a string to a locale-formatted
number.

Настройки

• In the Source value field, specify the source string.
• Select any of the following tab to specify locale:

• Specify: Manually specify the two letter ISO codes for the locale you want to use in the Locale
field.

• Device: Use the default locale configured for the device.

• In the Save the outcome to a variable list, specify the variable.

You can also use the action in an expression. For example, $prompt-
assignment.String:toLocaleNumber("en-US")$.

To number action
The To number action in the Строка пакет enables you to convert a string to a number.

Настройки

This action supports positive, negative, and decimal numbers.

Прим.:  If the string contains commas, remove them by using the Replace action to replace each comma
with an empty string.

• In the Enter the string field, specify the source string.
• In the Assign the output to variable field, specify the number variable.

Trim action
The Trim action in the Строка пакет enables you to trim blanks, whitespaces, tabs, and line breaks from a
string.

Настройки

• In the Source string field, specify the source string.
• In Trim from the beginning and Trim from the end, select options.
• In the Assign the output to variable field, specify the variable.

Uppercase action
The Uppercase action in the Строка пакет enables you to convert the source string to uppercase.
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Настройки

• In the Source string field, specify the source string.
• В списке Присвоить выходные данные переменной укажите переменную.

Import string from text file action
The Import string from text file action in the Строка пакет enables you to import values from a
variable in a text file into a string variable.

Настройки

• Select the text file from the Control Room, desktop, or a file variable.
• In the Variable key field, specify the variable that holds the values to import. This field is not case-

sensitive.
When a бот runs this action, it retrieves the values between the = sign and line break.

• In the Assign the output to variable list, specify the variable.

Прим.:  If you built a бот using this action from the Строка пакет from Сборка 5322 or earlier, the action
will be missing when you open the бот with the default пакет version. You must reinsert the action and
repopulate the fields.

Система пакет
Use the actions in the Система пакет to automate locking, logging off, restarting, and shutting down the
computer. Use these actions at the end of a task.
пакет Система включает в себя указанные ниже actions.

Прим.:  If you are on Automation 360 v.22 (Build 10526) or a later version, we recommend that you use
the Automation 360 v.22 or a later Система пакет version to run your боты seamlessly.

Действие Описание

Заблокировать
компьютер

См. раздел Lock computer action.

Завершить сеанс См. раздел Logoff action.

Перезагрузка См. раздел Restart action.

Завершение работы См. раздел Shutdown action.

Получить
переменную среды

См. раздел Get environment variable action.

Задачи, связанные с данной
Using Log to file action
The Log to file action in the Записать в файл пакет enables you to create a log file with data about the
events that occur when a TaskBot runs.
Ссылки, связанные с данной
Приложение пакет
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Use the Open Program/File action in the Приложение пакет to launch an application or a file. This
action supports .exe, .bat, script files, or shortcut paths.

Lock computer action
The Lock computer action enables you to lock the local machine on which the бот is run.

Logoff action
The Logoff action enables you to log off from the current user session of the local machine on which the
бот is run.

Restart action
The Restart action enables you to restart the local machine on which the бот is run.

Shutdown action
The Shutdown action enables you to turn off the local machine on which the бот is run .

Get environment variable action
The Get environment variable action enables you to get all the environment variables from the
specified local machine and assign it to a variable.

Настройки

• (Optional) In the Environment variable list tab, click the drop-down menu and select one of the
variables.
The following table lists the variable details:

Переменная Описание Example value

ALLUSERSPROFILE Returns the path to the directory
that contains resources and settings
used by all system accounts.

Прим.:  Use ProgramData for
devices that run Windows Vista and
later OS.

C:\ProgramData

APPDATA Returns the file path to the
application data directory. This
directory contains the settings for
applications shared across multiple
devices.

C:\Users\<user>
\AppData
\Roaming

COMPUTERNAME Returns the device name without
the domain.

AA-NY-
FRANKSINATRA

CommonProgramFiles Returns the file path to the Common
 Files directory.

C:\Program Files
\Common Files

CommonProgramFiles(x86) Returns the file path to the Common
 Files directory.

Прим.:  This is only available for
devices that run 64-bit version.

C:\Program Files
(x86)\Common
Files
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Переменная Описание Example value

CommonProgramW6432 Returns the file path to the Common
 Files directory.

Прим.:
• This is only available for devices

that run 64-bit version.
• Only use CommonProgramW6432

for devices that run Windows
Vista and later OS

C:\Program Files
\Common Files

ComSpec Returns the file path to the
command processor

C:\Windows
\system32\cmd.exe

DriverData Returns the file path to the Driver
 Data directory.

C:\Windows
\System32\Drivers
\DriverData

HOMEDRIVE Returns the home drive of the
device.

C:

HOMEPATH Returns the homepath of the device
without the system drive.

\Users\<user>

LOCALAPPDATA Returns the file path to the
application data directory. This
directory contains the settings for
applications shared across multiple
devices.

C:\Users\<user>
\AppData\Local

LOGONSERVER Returns the name of the group
or domain to which the device is
connected

\\SJCSRVBKP

NUMBER_OF_PROCESSORS Returns the number of processors in
the device.

4

OneDrive Returns the path to the OneDrive
folder.

C:\Users\<user>
\OneDrive

OS Returns the device operating system
name.

Windows_NT

Путь Returns a semicolon-delimited list of
directories that contain executable
programs.

C:\Windows
\system32;C:
\Windows;C:
\Windows
\System32\Wbem;C:
\Windows
\System32\WindowsPowerShell
\v1.0\

PATHEXT Returns a semicolon-delimited list of
file extensions that the system can
execute.

.COM;.EXE;.BAT;.CMD;.VBS;.VBE;.JS;.JSE;.WSF;.WSH;.MSC
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Переменная Описание Example value

PROCESSOR_ARCHITECTURE Returns the process architecture of
the device.

AMD64

ProgramData Returns the path to the directory
that contains resources and settings
used by all system accounts.

Прим.:  Use ALLUSERSPROFILE
for devices that run the Windows XP
and earlier OS.

C:\ProgramData

ProgramFiles Returns the path to the directory
that stores installed programs.

C:\Program Files

ProgramFiles(x86) Returns the path to the directory
that stores installed programs.

Прим.:  This is only available for
devices that run 64-bit version.

C:\Program Files
(x86)

ProgramW6432 Returns the path to the directory
that stores installed programs.

C:\Program Files

PSModulePath Returns file paths to the modules
that are installed on the disk.

%ProgramFiles%
\WindowsPowerShell
\Modules;C:
\Windows
\system32\WindowsPowerShell
\v1.0\Modules

PUBLIC Returns the Public folder path. C:\Users\Public

SystemDrive Returns the device system drive. C:

SystemRoot Returns the system root folder. C:\Windows

TMP Returns the path to the directory
that stores temporary files.

C:\Users\<user>
\AppData\Local
\Temp

TEMP Returns the path to the directory
that stores temporary files.

C:\Users\<user>
\AppData\Local
\Temp

USERDNSDOMAIN Returns the DNS domain of the
user.

AAI.AASPL-
BRD.COM

USERDOMAIN Returns the domain of the user. AAI.AASPL-
BRD.COM

USERDOMAIN_ROAMINGPROFILE Returns the domain of the user
profile.

AAI

USERNAME Returns the logged-in user name. bob.ross

USERPROFILE Returns the user profile path. C:\Users\<user>
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Переменная Описание Example value

windir Returns the Windows directory
path.

C:\Windows

• (Optional) Use the Variable tab to add a value for the variable.
Click Insert a value icon if there is no existing variable.

• Click the Assign the output to an existing variable drop-down menu and select an existing
variable.
Click the Create variable icon for new variable.

TaskBot пакет
Use the Run, Pause, and Stop actions in the TaskBot пакет to manage running one or more child боты
from a parent бот or with a third-party software using an API.
Build smaller боты that automate a single task and run them from a parent бот. For example, build a
Login child бот to enter the username and password into a web form and click submit. The Login child
бот accepts credentials from the parent бот and returns a success message, and then the parent бот can
call the subsequent CreateInvoice child бот. The Login child бот should also contain error handling
logic in case the credentials are incorrect.
This practice of building smaller, self-contained боты enables a user to reuse the бот logic in a greater
number of tasks, and makes error handling and troubleshooting easier. This also decreases the amount
of time spent building and maintaining боты. As a result, an organization is able to rapidly scale their
automation initiatives. The Login child бот from this example can be reused in any task that involves
providing credentials to a login page on a website.
When you run a TaskBot that calls itself repeatedly until you choose to stop it, the бот runs infinitely and,
as a result, encounters an error related to stack memory issues. We recommend that you create a parent
and a child бот with different names and then run the child бот from the parent бот.

Прим.:
• CSV/text file and Recorder sessions cannot be shared across боты. You can share Excel sessions across

боты by using a session variable. См. раздел Example of sharing an Excel session between bots.
• When you use a file type variable in the Выполнить задачу, ensure you have set the default value in

the variable. Without default value, the бот displays an error on execution.

In addition, running child боты from a parent бот offers greater control over data in the following ways:
• Users can configure the variables in the child бот to control the direction in which information can be

exchanged by selecting from the following options:
• Use as input: The variable holds a value that the child бот accepts from a parent бот or third-party

software.
• Use as output: The variable holds a value that the child бот passes to the parent бот or third-party

software.
• Both: The value can be passed in both directions.
• Neither: The variable is confined to this бот; it cannot be shared across other боты.

См. Create a variable
• Other users can reuse child боты without viewing their contents.

пакет TaskBot включает в себя указанные ниже actions.
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Действие Описание

Приостановить См. раздел Pause action.

Запустить • See Using the Run action..
• For an example, see Example of using the Run action.

Остановить См. раздел Stop action.

Pause action
The Pause action in the TaskBot пакет enables you to temporarily pause the running бот.

Настройки

Temporarily pauses the running бот. Use the Pause action to modify data or to verify the status of a
relevant component.
When the бот reaches the Pause action during run time, a Resume button appears. You must click
Resume for the бот to continue to the next action.

Using the Run action
The Run action from the TaskBot пакет enables you to run one or more child боты. Configure the action
to run the child боты repeatedly or with a delay, and to pass and retrieve values.
The action runs the selected task multiple times for a specified number of times or for a number of hours.
The task can be repeated until the user chooses to stop it. You can save the output values to a dictionary
variable, where each key in the dictionary is the variable name and corresponding value from the child
бот.Or, you can map each dictionary key to a variable to store the corresponding value.

Прим.:  When you create a TaskBot with dependencies, ensure that the both the parent and child бот are
in the same workspace (public or private). You cannot call a public бот from a private бот. To do so, you
should first either check-out or clone the public бот into the private workspace and then check-in both the
боты to the public workspace.

1. In the Действия palette, double-click or drag the Run action from the Task Bot пакет.
2. In the Task Bot to run field, select the child бот:

Вариант Описание

Текущий TaskBot Runs the current бот recursively.

© 2023 Automation Anywhere. All rights reserved.     1910



    Automation Anywhere - Сборка

Вариант Описание

Файл Control Room Select a бот that you want to run:
• Click the Browse tab if you want to select a

бот from your private workspace.
The location of the selected бот in the private
repository is also displayed.

• Click the Search tab if you want to search
for a бот from the public workspace and your
private workspace.
Suggestions about the боты available in the
public and private workspaces are displayed
when you start typing the name of the бот
you want to run. The location of the selected
бот in the public and the private workspaces
is also displayed.

Переменная Выберите один из указанных ниже
параметров.
• File: Insert a file variable that contains a бот.
• Control Room path: Enter an expression

beginning with Bots that contains a string
variable to specify the бот. For example
Bots/$department$/PTOReport.

Прим.:
• The file path is case-sensitive.
• The бот must be in the same workspace as

the parent бот.

3. In the Input values fields, enter the values or variables to pass to the child бот:

Прим.:  You can pass a Window type variable from a parent бот to a child бот.

a) Select an input variable to activate the text field.
b) Enter a value of the required data type.

The icon on the left-side of the text field indicates the data type.

If you are configuring a бот with many input variables, use the Quick map option to automatically
map variables that share the same name and data type. If the child бот contains variables for which
there are no corresponding variables in the parent бот, the Quick map option creates new variables
and maps them.

4. Необязательно: Select the repetition.
5. Необязательно: Select the Delay between repetitions option and enter the delay time in the

Minutes and Seconds fields.
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6. Необязательно: Select the Upon error continue with next repetition or action in this bot
option.
For alternative error-handling options, use actions from the Обработчик ошибок пакет.

Обработчик ошибок пакет
7. In the Save outcome to a variable field, select either the Multiple variables or Dictionary

option:
Вариант Описание

Несколько переменных Click Add variable mapping to associate each
dictionary key with a variable in the parent бот.
Используйте этот параметр, если не хотите
использовать actions для извлечения значений
словаря.
Use the Multiple Variables option to assign
the output of the child бот to multiple variables
directly. Using this option, you can set the
multiple values returned by the child бот into
the dictionary variable of the parent бот. You no
longer need to assign the multiple outputs of the
child бот to the individual variables of the parent
бот using variable assignment commands. You
can use the Словарь пакет in the parent бот
to extract the individual value assigned to the
dictionary variable of the parent бот.
For example, when you migrate Enterprise 11
боты, many output variables need to be assigned
individually after the Run task action, which
increases the size of the бот. You can directly set
parent бот variables within the Run task action
using the multiple variables option.

Словарь Вставьте или создайте переменную словаря
для хранения выходных переменных и
значений в парах «ключ-значение».
Each key in the dictionary is the variable name
and corresponding value from the child бот.

8. Щелкните Сохранить.

For an example of using this action:
• Example of using the Run action
• Example of sharing an Excel session between bots

Repeating a бот
Repeat a бот after run failure or when running routine боты.

Options for repeating a бот

Не повторять Default. The бот runs once.
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Повторить N раз Repeats the бот specified number of times.
Повторить для единицы времени Repeats the бот for a time period (hh:mm:ss).

Прим.:  Specify up to 99 hours, 59 minutes, or 59
seconds.

Повторять до остановки пользователем Repeats the бот until being stopped manually by
clicking the stop button or by pressing the ESC
key.

Задержка между повторениями Sets a duration of time to wait before repeating a
бот (mm:ss).

Upon error continue with next repetition or
action in this бот

The бот is repeated regardless of run failure.

Прим.:  Error handling cannot capture the error
when this option is enabled.

Stop action
The Stop action in the TaskBot пакет enables you to stop the running бот.

Настройки

For example, use the Stop action to terminate the бот if a condition is met, such as if the бот encounters
a file larger than 100 MB.

Example of sharing an Excel session between bots
Build two боты to update the employee salaries in a worksheet. In this example, one бот opens an Excel
worksheet and passes the session name as a variable to the second бот, which iterates through the
worksheet, calculates each employee's new salary, and updates the value in the worksheet.
Create a worksheet with the following data:

Employee ID Дата начала Salary

200 2020-1-12 50000

233 2018-3-15 75000

500 2020-6-06 60000

555 2019-7-09 65000

Build the child to iterate through the table of employees and update each salary to reflect the raise.
1. Откройте нового бот.

a) From Automation Anywhere web interface, on the left panel, click Automation.
Отобразится список доступных ботов и форм.

b) Щелкните Создать бота.
c) Enter the бот name RaiseSalaries.
d) Enter the folder location \Bots\TaskBotExample.

Чтобы изменить папку сохранения бот, щелкните Выбрать и следуйте подсказкам.
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e) Щелкните Создать и редактировать.

2. Create the following variables:
• sessionVariable: session type; MS Excel subtype; use as input
• sCellAddress: string type; default value of C2
• sSalary: string type
• nSalary: number type

3. Use a Loop action to iterate through all the rows in the worksheet.
a) Дважды щелкните или перетащите action Цикл.
b) Select the For each row in worksheet iterator.
c) Select the Shared session tab and insert $sessionVariable$.
d) Select the Read cell value option.
e) In the Assign the current value to this variable field, create a record variable.

4. Retrieve the employee's salary.
a) Drag into the Loop container the Excel Advanced > Get single cell action.
b) Select the Shared session tab and insert $sessionVariable$.
c) Select the Specific cell option and insert $sCellAddress$.
d) Select the Read cell value option.
e) In the Store cell contents to field, insert $sSalary$.

5. Convert the salary value to a number data type.
a) Drag into the Loop container the String > To number action.
b) In the Enter the string field, insert $sSalary$.
c) In the Assign the output to variable field, insert $nSalary$.

6. Calculate the new salary to be five percent greater than the current salary.
a) Drag into the Loop container the Number > Assign action.
b) In the Select source variable field, enter $nSalary$*1.05.
c) In the Select destination variable field, insert $nSalary$.

7. Update the salary in the worksheet.
a) Drag into the Loop container the Excel Advanced > Set cell action.
b) Select the Shared session tab and insert $sessionVariable$.
c) Select the Specific cell option and insert $sCellAddress$.
d) In the Cell value field enter $nSalary.Number:toString$.

Прим.:  You must convert the value to a string data type before the бот can enter it into the
worksheet. Use type casting as an alternative to the Number > To stringaction. Type conversion
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8. Move the cursor down by a single cell and assign that cell address to sCellAddress.
a) Drag into the Loop container the Excel Advanced > Go to cell action.
b) Select the Shared session tab and insert $sessionVariable$.
c) Select the Active cell and One cell below options.
d) Drag into the Loop container the Excel Advanced > Get cell address action.
e) Select the Shared session tab and insert $sessionVariable$.
f) Select the Active cell option.
g) In the Save active cell address field, insert $sCellAddress$.

9. Click Save and Close.
Build the parent бот.
10. Откройте нового бот.

a) Щелкните Создать бота.
b) Enter the бот name ExcelParentBot.
c) Enter the folder location \Bots\TaskBotExample.

Чтобы изменить папку сохранения бот, щелкните Выбрать и следуйте подсказкам.
d) Щелкните Создать и редактировать.

11. Create the following variable:
sessionVariable: session type; MS Excel subtype

12. Open the Excel worksheet.
a) Double-click or drag the Excel Advanced > Open action.
b) In the Session name field, enter Session1.
c) In the File path field, enter the file path to the worksheet you created above.
d) Select the Sheet contains header option.

13. Assign the session to a variable.
a) Double-click or drag the Excel Advanced > Set session variable action.
b) In the Session name field, enter Session1.
c) In the Save session to a variable field, select $sessionVariable$.

14. Select the child бот you built in the above.
a) Double-click or drag the Task Bot > Run action.
b) Click the Control Room file option and click Browse to select the RaiseSalaries бот.
c) In the Input values section, select the Set SessionVariable option and insert

$sessionVariable$.

15. Click Save and Run.
The Excel worksheet opens and the value of each cell in the third column increases by five percent.

© 2023 Automation Anywhere. All rights reserved.     1915



    Automation Anywhere - Сборка

Terminal Emulator пакет
The Terminal Emulator пакет contains actions that enable you to connect to and automate tasks on
another machine. Use these actions to access and control operations on a remote machine. For example,
you can run applications and access files on a different operating system.
The Terminal Emulator enables a machine to connect to and communicate with another machine
using a command-line or graphical interface. The Terminal Emulator uses the Telnet or SSH protocol to
communicate with other machines.
The Terminal Emulator supports ANSI, TN3270E, TN5250E, and VT100 terminal types.

Important:  If you use different versions of the Эмулятор терминала пакет in a parent бот and a child
бот, the capability to share a session across боты is currently not supported. To share a session across
parent and child боты, ensure that you use the same version of the package in both the parent and child
боты.

Перед началом работы

Важное замечание:  Before you establish a connection to a different terminal type, ensure that you
have Visual C++ 2019 Redistributable Package installed on your system. If you are on an Automation 360
version earlier than A2019.14 (Build 5322), you must install Visual C++ 2013 Redistributable Package or
Visual C++ 2015 Redistributable Package on your system.

Perform the following actions within the Terminal Emulator package as part of using the set of available
actions:
1. Establish a connection with a host machine using the Connect action.

You must first establish a connection with a host machine to automate any Terminal Emulator related
task. When establishing the connection, specify the details of the host machine and associate it with
a session name. Use the session name provided in this action in the other actions so that you do not
have to provide details of the host machine in those actions again. См. раздел Using Connect action for
Эмулятор терминала.

Важное замечание:  If you use any other action from this пакет before establishing the
connection, you will encounter an error.

2. Use the Terminal Emulator actions to automate a task. For example, use the Get field action to
retrieve the value from a particular field.

3. After you have automated all the Terminal Emulator related tasks, terminate the connection to the
host machine using the Disconnect action.

Действия in the Terminal Emulator package

The Terminal Emulator package includes the following actions:

Действие Описание

Очистить терминал Clear terminal action

Подключить Using Connect action for Эмулятор терминала
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Действие Описание

Отключить Disconnect action

Получить все поля Get all fields action

Получить поле Get field action

Получить текст Using Get text action for Эмулятор терминала

Скрыть терминал Hide terminal action

Поиск поля Search field action

Отправить ключ Using Send key action

Отправить текст Using Send text action

Установить позицию
курсора

Set cursor position action

Установить поле Using Set field action

Задать переменную
сеанса

Set session variable action

Показать терминал Show terminal action

Ожидать Using Wait action

Clear terminal action
The Clear terminal action in the Эмулятор терминала пакет enables you to clears the screen of the
terminal.

Настройки

Specify the Terminal emulator session name that you used to establish a connection with the terminal
using the Connect action.

Using Connect action for Эмулятор терминала
Use the Connect action to establish a connection with a host machine on which you want to automate
a task. You can use this action to establish a connection with the TN3270E, TN5250E, ANSI, VT220, and
VT100 terminal types.
This action enables you to specify the details of the host machine and associate it with a session name.
Use the session name provided in this action in the other actions, so that you do not have to provide
details of the host machine in those actions again.

Важное замечание:  If you use any other action from this пакет before establishing the connection,
you will encounter an error.

To establish a connection with a host machine, perform the following steps:
1. Double-click or drag the Connect action from the Terminal Emulator node in the Actions palette.
2. Specify a name for the session in the Terminal emulator session name field.
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Прим.:  Use the different session name to open multiple terminal windows. If you want to use the
same session name, you must first close the session of the first terminal window before using the
same session name for another terminal window.

3. Specify the Host name of the machine you want to connect to:
a) Click the Credential tab to select an entry from the Credential Vault.
b) Click the Variable tab to use a variable to specify the host name.

4. Enter a value in the Port field to specify the port you want to use to connect to the host.
5. Select one of the following options to specify the terminal type:

Вариант Шаги

ANSI Select an option from the Connection type list to specify the type of
connection you want to establish:
• Telnet
• SSH2

For SSH2 connection type:
• For User authentication:

• User name: Click the Credential tab to select an entry from
the Credential Vault. You can also click the String tab to enter a
value manually.

• For Password: Click the Credential tab to select an entry from
the Credential Vault. You can also click the String tab to enter a
value manually.

• For Key file authentication: Click one of the following options to
specify the location of the file:
• Control Room file: Enables you to select a PDF file that is

available in a folder.
• Desktop profile: Enables you to select a PDF file that is

available on your device.
• Переменная. Enables you to specify the file variable that

contains the location of the PDF file.

• For User name: Click the Credential tab to select an entry from
the Credential Vault. You can also click the String tab to enter a
value manually.
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Вариант Шаги

TN3270E a. Select an option from the Host name security list to specify the
security you want to use:
• NONE
• SSL
• TLS

b. Select the Enable TN3270E support check box if you want to choose
a connection method.
Select an option from the Connection method list:
• GENERIC: Enables you to specify the Device name.
• SPECIFIC: Enables you to specify the Device name and

Resource (LU) Name.

c. Select an option from the Terminal model list to specify the terminal
workstation you want to connect to.

d. Select an option from the Code page list to specify the encoding you
want to use for the terminal.

TN5250E a. Select an option from the Host name security list to specify the
security you want to use:
• NONE
• SSL
• TLS

b. Select the Enable TN5250E support check box if you want to specify
details about the device and resource.
Enter a value in the Device name and Resource (LU) Name fields.

c. Select an option from the Terminal model list to specify the terminal
workstation you want to connect to.

d. Select an option from the Code page list to specify the encoding you
want to use for the terminal.
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Вариант Шаги

Серия VT
• VT100
• VT220

a. Select an option from the Terminal model list to specify the terminal
type you want to connect to.

b. Select an option from the Encoding list to specify the encoding you
want to use for the terminal:
• ANSI
• DBCS
• UTF-8

The CodePage field appears when DBCS option is selected. The
CodePage supports only Japanese Shift-JIS (932).

c. Select an option from the Connection type list to specify the type of
connection you want to establish:
• Telnet
• SSH2

For SSH2 connection type:
• For User authentication:

• User name: Click the Credential tab to select an entry
from the Credential Vault. You can also click the String tab
to enter a value manually.

• For Password: Click the Credential tab to select an entry
from the Credential Vault. You can also click the String tab
to enter a value manually.

• For Key file authentication: Click one of the following options
to specify the location of the file:
• Control Room file: Enables you to select a PDF file that is

available in a folder.
• Desktop profile: Enables you to select a PDF file that is

available on your device.
• Переменная. Enables you to specify the file variable that

contains the location of the PDF file.

• For User name: Click the Credential tab to select an entry
from the Credential Vault. You can also click the String tab to
enter a value manually.

6. Select the Show terminal window check box to show the terminal window when the бот runs this
action.

7. Select the Set cursor position to the beginning check box to edit the screen of the Terminal
emulator session manually and set the focus to the first editable field.

8. Select the Wait for the terminal prompt to appear while connected check box to wait for the
terminal prompt to appear on the screen of the terminal after the connection is established.
a) Enter the text you want to display when you connect to the terminal in the Terminal prompt

field.
b) Enter a value in the Wait time out field to specify the period in (milliseconds) the system must

wait before the connection request is timed out.
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9. Select any of the following tabs to create a terminal emulator session:
• Локальный сеанс Укажите имя сеанса, которое можно использовать только в текущем бот.
• Глобальный сеанс Specify a session name that can be used across multiple боты such as

parent боты, child боты, and other child боты of the parent боты.
• Переменная. Укажите переменную сеанса, которую можно применить для совместного

использования этого сеанса с другими дочерними боты.

Disconnect action
The Disconnect action in the Эмулятор терминала пакет enables you to terminate the connection with
the terminal.

Настройки

Specify the Terminal emulator session name that you used to establish a connection with the terminal
using the Connect .

Get all fields action
The Get all fields action in the Эмулятор терминала пакет enables you to retrieve the values of all fields
and assigns them to a table variable.

Настройки

• Specify the Terminal emulator session name that you used to establish a connection with the
terminal using the Connect .

• Select a table variable to store the retrieved data from the Assign the value to an existing table
variable list. The table stores each field as a row, with the values of each field organized in the
following columns:
• Индекс поля
• Имя поля
• Значение поля
• Is Editable (yes/no)
• Is Hidden (yes/no)

Прим.:  You can use this action with the TN3270E and TN5250E terminal types.

Get field action
The Get field action in the Эмулятор терминала пакет enables you to retrieve the value of a field based
on the index or name of the field and assigns it to a string variable.

Настройки

• Specify the Terminal emulator session name that you used to establish a connection with the
terminal using the Connect .

• Select the By index option to retrieve the value of a field based on its index, or select the By name
option to retrieve the value of a field based on its name.
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• Select a string variable to store the retrieved data from the Assign the value to an existing
variable list.

Прим.:  You can use this action with the TN3270E and TN5250E terminal types.

Using Get text action for Эмулятор терминала
Use the Get text action to retrieve text from the terminal and store it in a string variable. This action
enables you to retrieve text from the last line, all lines, or a range of lines. You can use this action with the
TN3270E, TN5250E, ANSI, and VT100 terminal types.
To retrieve text from the terminal, do the following:
1. Double-click or drag the Get text action from the Terminal Emulator node in the Actions palette.
2. Enter the name of the session that you have used to establish a connection with the terminal using

the Connect action in the Terminal emulator session name field.
3. Select an option from the Get text list to specify the lines from which you want to retrieve text:

• Last line: Retrieves text from the last line of the terminal.
• All lines: Retrieves text from all lines of the terminal.

Select from the following options to extract text from a specific area, viewable area, or the entire
page displayed on the screen.
• Viewport: Retrieves text from the visible area of the Эмулятор терминала window.
• Number of lines from top: To retrieve text corresponding to a specific number of lines from

the top of the screen.
• Full page capture (with scroll): Retrieves all the lines on the screen, including the content

that needs to be scrolled to access it.

Прим.:  The Full page capture (with scroll) and Number of lines from the top options
are supported only for ANSI and VT Series terminals. If you connect with other terminal types,
regardless of the option selected, the extracted text displays the results similar to how they are
displayed for the Viewport option.

• Lines from-to: Retrieves text from the specified range of lines of the terminal. You must enter
values in the Start row and End row fields to specify the range.

Прим.:  You can specify a value of 1 through 999.

4. Select a string variable from the Assign the value to an existing variable list to assign the
retrieved text to that variable.

5. In the Assign value to variable list, select a string variable.

Hide terminal action
The Hide terminal action in the Эмулятор терминала пакет enables you to hide the terminal screen.

Настройки

This action enables you to hide the terminal screen when the Show terminal window option from the
Connect action is selected. It is useful when you do not want to display the terminal screen when a бот
is performing certain tasks. Specify the Terminal emulator session name that you used to establish a
connection with the terminal using the Connect .
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Search field action
The search field action in the Эмулятор терминала пакет enables you to search for the field based on the
text it contains.

Настройки

• From the Terminal emulator session name field, choose one of the following options:
• Local name to establish a connection with the terminal using the Connect action
• Shared session to share the variable from Set session variable or from the parent бот

• Specify the text based on which you want to search the field.
• Select an option from Select field to specify whether to retrieve the index or name of the field.
• Assign and save the output to a variable.

Прим.:  The search text you enter must be a complete match and is not case-sensitive.

Using Send key action
Use the Send key action to send a key to the terminal. You can use these keys to perform various
operations on the terminal. You can use this action with the TN3270E, TN5250E, ANSI, and VT100 terminal
types.
To send a key to the terminal, do the following:
1. Double-click or drag the Send key action from the Terminal Emulator node in the Actions palette.
2. Enter the name of the session that you have used to establish a connection with the terminal using

the Connect action in the Terminal emulator session name field.
3. Select an option from the Select key to be send list to specify the key you want to send.
4. Enter a value in the Delay after send key command field to specify the period the system must

wait (in milliseconds) after the selected key is sent.
5. Select the Wait for text or prompt to appear check box if you want the system to wait for the

prompt or certain text to appear on the terminal.
a) Select the Prompt option if you want the system to wait till the prompt appears on the terminal.
b) Select the Text option if you want the system to wait till the specific text appears on the terminal.

You must provide the text you want to appear on the terminal in the Text value to be appear
on screen field.

c) Select the Wait before send key for prompt or text appear check box if you want the
system to wait for the prompt or the specified text to appear on the terminal before sending the
selected key.

d) Select the Wait after send key for prompt or text appear check box if you want the system
to wait for the prompt or the specified text to appear on the terminal after sending the selected
key.

e) Enter a value in the Time out for prompt or text to appear field to specify the period (in
seconds) the system must wait before the operation times out.

6. In the Assign value to variable list, select a string variable.

How send key works in Send text action
Learn how keys work in the Send Text action in the Эмулятор терминала.
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Прим.:  Behavior of the keys that are marked with the asterisk (*) sign in the following tables is defined
by the terminal host. The behavior might vary on different terminals.

The following table shows the behavior of the keys in the terminal types TN3270 and TN5250:

Keys Behavior

KEY_BACKSPACE Same behavior as the Backspace key on the keyboard.

KEY_BACKTAB If the cursor is on the first position of a field, it moves to the
previous field. Otherwise, it moves to the start of the current
field.

KEY_CLEAR Clears the entire text on the terminal screen.

KEY_ERASEINPUT Deletes all the text in the field.

KEY_NEXTFIELD Moves the cursor to the next field on the terminal screen.

KEY_ENTER Sends Enter key to the terminal host.

KEY_HOME Moves the cursor to the first editable field on the screen.

KEY_RESET The reset key only clears the Keyboard lock, such as releasing the
terminal if the terminal screen is not working. The screen text and
input field values remain the same.

KEY_LEFT Moves the cursor to the left by one position.

KEY_RIGHT Moves the cursor to the right by one position.

KEY_UP Moves the cursor up by one position.

KEY_DOWN Moves the cursor down by one position.

KEY_PGLEFT Nothing happens.

KEY_PGRIGHT Nothing happens.

KEY_PGUP Page Up key

KEY_PGDOWN Page Down key

KEY_TABFORWARD Performs a tab key action on the terminal screen to move the
cursor to the next field.

KEY_PF1 * Same behavior as F1 key on the keyboard.

KEY_PF2 * Same behavior as F2 key on the keyboard.

KEY_PF3 * Same behavior as F3 key on the keyboard.

KEY_PF4 * Same behavior as F4 key on the keyboard.

KEY_PF5 * Same behavior as F5 key on the keyboard.

KEY_PF6 * Same behavior as F6 key on the keyboard.

KEY_PF7 * Same behavior as F7 key on the keyboard.

KEY_PF8 * Same behavior as F8 key on the keyboard.

KEY_PF9 * Same behavior as F9 key on the keyboard.

KEY_PF10 * Same behavior as F10 key on the keyboard.

KEY_PF11 * Same behavior as F11 key on the keyboard.
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Keys Behavior

KEY_PF12 * Same behavior as F12 key on the keyboard

KEY_PF13 * Same behavior as Shift + F1 keys on the keyboard.

KEY_PF14 * Same behavior as Shift + F2 keys on the keyboard.

KEY_PF15 * Same behavior as Shift + F3 keys on the keyboard.

KEY_PF16 * Same behavior as Shift + F4 keys on the keyboard.

KEY_PF17 * Same behavior as Shift + F5 keys on the keyboard.

KEY_PF18 * Same behavior as Shift + F6 keys on the keyboard.

KEY_PF19 * Same behavior as Shift + F7 keys on the keyboard.

KEY_PF20 * Same behavior as Shift + F8 keys on the keyboard.

KEY_PF21 * Same behavior as Shift + F9 keys on the keyboard.

KEY_PF22 * Same behavior as Shift + F10 keys on the keyboard.

KEY_PF23 * Same behavior as Shift + F11 keys on the keyboard.

KEY_PF24 * Same behavior as Shift + F12 keys on the keyboard.

Using Send text action
Use the Send text action to send text to the terminal. This action also enables you to send predefined
keys after the text to perform various operations in the terminal. You can use this action with the
TN3270E, TN5250E, ANSI, and VT100 terminal types.
You can use the following keyboard shortcuts to send a key on the terminal window using Simulate
keystroke action:

Прим.:  The keyboard shortcuts are supported in TN3270 and TN5250.

Key entry Команда

Shift + Control + A Выбрать все

Shift + Control + C Копировать

Shift + Control + X Вырезать

Shift + Control + V Вставить

To send a text to the terminal, follow these steps.
1. Double-click or drag the Send text action from the Terminal Emulator node in the Actions palette.
2. Enter the name of the session that you have used to establish a connection with the terminal using

the Connect action in the Terminal emulator session name field.
3. Specify the Text you want to send to the terminal:

a) Click the Credential tab to select an entry from the Credential Vault.
b) Click the Variable tab to use a variable that contains the text you want to send.

4. Select the Send a key after sending the above text check box if you want to send a key after
sending the text.
a) Select the key you want to send from the list.
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b) Enter a value in the Delay after send key command field to specify the period (in milliseconds)
the system must wait after sending the selected key.

5. Select the Wait for text or prompt to appear check box if you want the system to wait for the
prompt or certain text to appear on the terminal.
a) Select the Prompt option if you want the system to wait till the prompt appears on the terminal.
b) Select the Text option if you want the system to wait till the specific text appears on the terminal.

You must provide the text you want to appear on the terminal in the Text value to be appear
on screen field.

c) Select the Wait before send key for prompt or text appear check box if you want the
system to wait for the prompt or the specified text to appear on the terminal before sending the
selected key.

d) Select the Wait after send key for prompt or text appear check box if you want the system
to wait for the prompt or the specified text to appear on the terminal after sending the selected
key.

e) Enter a value in the Time out for prompt or text to appear field to specify the period (in
seconds) the system must wait before the operation times out.

6. In the Assign value to variable list, select a string variable.

Set cursor position action
The Set cursor position field action in the Эмулятор терминала пакет enables you to set the position of
the cursor on the screen of the terminal.

Настройки

• Specify the Terminal emulator session name that you used to establish a connection with the
terminal using the Connect .

• Specify the row number in which to set the cursor in the Set row field.
• Specify the column number in which to set the cursor in the Set column field.

Прим.:  You can enter a value of 1 through 999 to specify the row and column number where the cursor
is set.

Using Set field action
Use the Set field action to set a value in a particular field in the terminal. This action also enables you to
send predefined keys after the value to perform various operations in the terminal. You can use this action
with the TN3270E, TN5250E, ANSI, and VT100 terminal types.
To set a value for a field in the terminal, do the following:
1. Double-click or drag the Set field action from the Terminal Emulator node in the Actions palette.
2. Enter the name of the session that you have used to establish a connection with the terminal using

the Connect action in the Terminal emulator session name field.
3. Specify the field for which you want to set a value:

a) Select the By index option to specify the field based on its index.
The index value starts from zero and ends at 99999. For example, if you want to set the value for
the third field, you must specify 2 in this field.
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b) Select the By name option to specify the location of the field.
For example, if you want to set the value for a field in the fifth column of the third row, you must
specify R3C5 in the field.

4. Specify the Plain text value you want to set in the specified field:
a) Click the Credential tab to select an entry from the Credential Vault.
b) Click the Variable tab to use a variable that contains the text you want to send.

5. Select the Send enter key after setting field check box if you want to send the enter key after
setting the field.
This option performs the operation similar to pressing the Enter key after setting the value in the field.

6. Select the Send a key after sending the above text check box if you want to send a key after
sending the text.
a) Select the key you want to send from the list.
b) Enter a value in the Delay after send key command field to specify the period (in milliseconds)

the system must wait after sending the selected key.

7. In the Assign value to variable list, select a string variable.

Set session variable action
The Set session variable action in the Эмулятор терминала пакет enables you to assign the session name
to a variable.

Настройки

Pass this session variable from the parent бот to a child бот by entering the variable as an input type
variable in the child бот.

Show terminal action
The Show terminal action in the Эмулятор терминала пакет enables you to show the terminal screen.

Настройки

This action enables you to show the terminal screen when the Show terminal window option from the
Connect action is not selected. It is useful when you want to display the terminal screen when a бот is
performing certain tasks. You must specify Specify the Terminal emulator session name that you used
to establish a connection with the terminal using the Connect .

Using Wait action
Use the Wait action to introduce a delay till specific conditions are met in the terminal. You can use this
action to wait before executing the next action till the specific text appears on the screen, the cursor
moves to the specified location, and so on. You can use this action with the TN3270E, TN5250E, ANSI, and
VT100 terminal types.
To wait till specific conditions are met in the terminal, do the following:
1. Double-click or drag the Wait action from the Terminal Emulator node in the Actions palette.
2. Enter the name of the session that you have used to establish a connection with the terminal using

the Connect action in the Terminal emulator session name field.
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3. Select an option from the Terminal event list to specify a condition the system should wait till it is
met.
The following table provides information about the options available in the list and the input required
for each option:
Вариант Input required

Ожидать появления текста Waits until the text you specified in the Text field
matches with the last line of the screen in the
terminal.

Ожидать исчезновения текста Waits until the text you specified in the Text field
does not match or disappears on the last line of
the screen in the terminal.

Ожидать перемещения курсора в
позицию

Waits till the cursor moves to the position you
have specified in the Move to row and Move to
column fields.

Прим.:  You can enter a value of 1 through 999
to specify the row and column number where the
cursor is set.

Ожидать смещения курсора с позиции Waits till the cursor moves out of the position
you have specified in the Move out of row and
Move out of column fields.

Прим.:  You can enter a value of 1 through 999
to specify the row and column number where the
cursor is set.

Ожидать, пока экран не станет пустым No input required.

Ожидать, пока на экране не появится
текст

Waits till the text you have specified in the Text
field is available on the screen of the terminal.

Ожидать, пока не появится запрос
терминала

No input required.

Ожидать состояния готовности
терминала

No input required.

4. Enter a value in the How long you would like to wait? field to specify the period (in milliseconds)
the system must wait before the operation times out.

5. In the Assign value to variable list, select a string variable.

Share session between TaskBot logic
Use the Shared Session option in the Эмулятор терминала пакет to pass the exact state of an
application to the concurrently occurring TaskBot logic.
Shared session enables you to reuse actions between TaskBots that run concurrently, for example,
connecting to the same application.
To use shared session, create a hierarchy of TaskBot logic that are connected by the Shared Session
option. As a result, large TaskBot logic are trimmed by removing repetitive commands for connecting and
disconnecting.
1. Create a parent бот such as TE_Share_Main that connects to an application on the Эмулятор

терминала.
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2. Use the Set session variable action in the TE_Share_Main to assign the current session to a variable
such as $te_session$ of Terminal Emulator session type.

3. Create a child bot such as TE_BMIS to perform any actions such as Get text and Set field.
4. Add a Выполнить задачу action in the TE_Share_Main to call the TE_BMIS.
5. To pass a session variable from the TE_Share_Main to TE_BMIS , select $te_session$ as an input

value in the Set SessionVariable.
6. In the TE_BMIS , use Shared session tab and insert $te_session$ as a session variable to obtain

data or perform task.
7. In the main task, add an action to disconnect from the application.

Текстовый файл пакет
Open a text file, read data from that file, and save the data to a string variable by using the Text file
пакет. This package supports text files encoded in Shift-JIS, ANSI, UTF-16LE, UTF-16BE, Win 1521,
Unicode, and UTF-8 and can extract content up to 64kb from text files.

Действия в Текстовый файл пакет

пакет Текстовый файл включает в себя описанные ниже actions.

Действие Описание

Получить текст См. Using Get text action of Текстовый файл
пакет

Read variables См. Read variables action

Using Get text action of Текстовый файл пакет
Extract content from a text file and save that content to a string variable by using the Get text action.
To extract text from a text file, perform the following steps:
1. In the Actions palette, double-click or drag the Get text action from the Text file пакет.
2. In the Source file field, select an option to specify the location of the text file:

• Control Room file to open a file from the Control Room.
• Desktop file to open a file from the device. This field also accepts the file path input as a string

variable or global value.
• Variable to open a file by specifying a file variable.
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3. In the Text encoding field, select an encoding to specify the encoding that is applied on the text file.
Data from the text file will be retrieved based on the selected encoding option even if the input file
has a different encoding.
• ANSI
• UTF8
• UTF8 с BOM
• UNICODE
• Win1251
• UTF-16LE
• UTF-16BE
• Shift-JIS
• Detect automatically: identifies file encoding. This option supports UTF-8 with BOM, ANSI,

UTF-16LE, and UTF-16BE file encoding.

4. Select the Trim leading spaces and Trim trailing spaces check boxes to remove the leading and
trailing spaces from the data extracted from the text file.

5. In Save the outcome to variable field, select a string variable to hold the output.

Read variables action
You can use the Read variables action in the Текстовый файл пакет to read the values of variables from
the text file.

Настройки

• In the Source file field, select an option to specify the location of the text file:
• Control Room file: Opens a file from the Control Room.
• Desktop file: Opens a file from the device. This field also accepts the file path input as a string

variable or global value.
• Переменная. Opens a file by specifying a file variable.

• In the Text encoding field, specify the encoding to apply on the text file. Data from the text file is
retrieved based on the selected encoding option even if the input file has a different encoding.
• ANSI
• UTF-8
• UTF-8 с BOM
• Юникод
• Windows 1251
• UTF-16LE
• UTF-16BE
• Shift-JIS
• Detect automatically: Identifies the file encoding. This option supports UTF-8 with BOM, ANSI,

UTF-16LE, and UTF-16BE file encoding.

• Select the Trim leading spaces and Trim trailing spaces check boxes to remove the leading and
trailing spaces from the data extracted from the text file.

• Select the Convert dictionary keys to lower case before assignment to variables to convert all
the keys to lower case.

Прим.:  When you select this option, ensure that you enter the key in lower case in the Mapped
variables table.
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• From the Save the outcome to variable field, select one of the following options to contain the
output:
• Несколько переменных. Click Add variable mapping to associate each dictionary key with a

variable. Use this option to avoid using actions to extract the dictionary values.
• Словарь. Insert or create a dictionary variable to contain the output variables and values in key-

value pairs.

Trigger loop пакет
The Trigger loop пакет enables you to run a series of actions when a trigger event occurs. You can insert
multiple trigger loops within a бот or nest one trigger loop within another trigger loop.

Действия in the Trigger loop пакет

Действие Описание

Trigger loop Opens the loop to run a series of actions when a trigger event occurs.

Прим.:  Events within the Trigger loop follow a sequential order and any
parallel events that occur during this time are queued.

Handle Specifies the trigger event and runs the actions that are inside the
container when that event occurs.
Drag the Handle action into the Trigger loop (in Flow view) or below
the Trigger loop (in List view).

Break Terminates the trigger loop for бот to continue with other actions in the
trigger event. If there is no Break action after a trigger loop handle,
the бот will go back to the start of the trigger loop and wait for the next
configured action. So ensure you add the Break action to exit the trigger
loop and move on to next action or else the бот will run indefinitely. For
example, the Break action in a бот can be used when the user must close
or cancel a form.
Drag the Break action into the trigger handle container.

Triggers in the Handle action

Trigger Описание Параметры

Hot key Trigger Runs the actions when specific keys are
pressed.

• Modifiers: Ctrl, Shift, Alt, AltGr, and
Win

• Keys:
• Letters A-Z
• Numbers 0-9
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Trigger Описание Параметры

Form Trigger Runs the actions when a form field is
modified. Select an existing form and
element.
Using interactive forms

• On click: Button is clicked.
• Got focus: Input field is clicked.
• Lost focus: User leaves the input

field.
• Changed value: Check box or

radio button status is changed.
• Value selected: Check box is

selected.
• Value unselected: Check box is

deselected.
• Assigned to (optional): Creates

or selects a variable, and assigns
the value from the specified form
element to this variable.

Object Trigger Runs the actions when an event occurs
on the selected interface element. For
example, when a user clicks a button.
Interface triggers for objects are
available only for native Windows
applications.

Задачи, связанные с данной
Add a form to бот
Adding an existing form to a bot enables users to collaborate with боты. Use the necessary action items to
create a бот and build a task logic.

V11 TaskBot пакет
The V11 TaskBot пакет enables you to run an Enterprise 11 бот from Automation 360 in the Enterprise
11 Control Room.

Действия in the V11 TaskBot пакет

The пакет includes the following action:

Действие Описание

Запустить См. раздел Using Run action.

Using Run action
Use the Run action to run an Enterprise 11 бот from Automation 360 in the Enterprise 11 Control Room.
Ensure that the Enterprise 11 user credential that you want to use to run the Enterprise 11 бот includes
the following:
• Access to the Enterprise 11 Bot Runner device on which you want to run the Enterprise 11 боты
• Run my bots and View my scheduled bots permissions
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To use the Send callback status to A2019 option, ensure the following:
• The IP address of the Automation 360 Bot Runner device on which you want to run the Automation 360

бот is a static IP address
• The IP address is available in the callback URL of the Enterprise 11 Control Room

Callback URLs for bot deployment

1. Double-click or drag the Run action from the V11 Task Bot node in the Actions palette.
2. Provide the Enterprise 11 Control Room URL in which you want to run the бот.
3. Click the Credential tab to use a value from the Credential Vault and the Variable to use a credential

variable.
Alternatively, click the Insecure string tab to manually specify the value you want to use as the
Username and Password to log in the Control Room you have specified.

4. Specify the location of the бот you want to run in the Task relative path field.
5. Необязательно: Specify the device on which you want to run the бот in the Bot Runner device

name field.
You can specify multiple devices separated by a semicolon. Ensure that the names of the devices you
have provided are the same as those on the My Devices page of the Enterprise 11 Control Room.
If you do not provide any value in the field, the system runs the бот on any connected devices (device
for which the user specified in the Step 3).

6. Select the Run bot runner session on Control Room check box to deploy the бот using the
remote desktop process.

7. Select the Wait for task to complete check box if you want the system to wait for the task to
complete before performing the next action in the бот.
a) Specify the period you want the system to wait before the бот is timed out in the Total wait

time field.
b) Select the version of the Control Room on which you want to run the бот.

• 11.3.2 or later (includes 11.3.3.x releases):
Click Advanced settings to expand and update the polling attributes.

Поле Описание

Wait time before start polling the status Period (in seconds) you want the system
to wait before it starts polling the status
after the бот is deployed on the device.

Polling interval for non-started execution Time interval at which you want
the system to poll for status for the
Enterprise 11 бот you have set to run but
has not started execution.

Polling interval for pending execution Time interval at which you want the
system to poll for status for the бот
that you have set to run and is pending
execution.

Polling interval for paused execution Time interval at which you want the
system to poll for status for the бот that
has started execution and is paused.
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Поле Описание

Polling interval for in-progress execution Time interval at which you want the
system to poll for status for the бот that
has started execution and is currently in
progress.

Polling interval for unknown execution Time interval at which you want the
system to poll for status for the бот that
has started execution and the current
status is unknown.

• 11.3.4 or later:
• Select the Send callback status to A2019 option to specify a range for the TCP port that you

want to use to send the callback status to Automation 360.

Поле Описание

Из доступного порта TCP Starting value in the range for the
TCP port that you want to use to send
the callback status.

В доступный порт TCP End value in the range for the TCP
port that you want to use to send the
callback status.

Прим.:  The IP address of the Automation 360 Bot Runner must be reachable from Enterprise
11 Control Room on the range for the TCP port you have provided.

• Select the Poll status from 11.x Control Room option. Click Advanced settings to update
the polling status from the Enterprise 11 Control Room:

Поле Описание

Wait time before start polling the
status

Period (in seconds) you want the
system to wait before it starts polling
the status after the бот is deployed
on the device.

Polling interval for non-started
execution

Time interval at which you want
the system to poll for status for the
Enterprise 11 бот you have set to run
but has not started execution.

Polling interval for pending execution Time interval at which you want
the system to poll for status for the
бот that you have set to run and is
pending execution.

Polling interval for paused execution Time interval at which you want the
system to poll for status for the бот
that has started execution and is
paused.

Polling interval for in-progress
execution

Time interval at which you want the
system to poll for status for the бот
that has started execution and is
currently in progress.
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Поле Описание

Polling interval for unknown execution Time interval at which you want the
system to poll for status for the бот
that has started execution and the
current status is unknown.

8. Select the dictionary variable from the Input parameters list that you want to use to pass input
parameters for the бот.
The input variables that you want to pass for the бот are contained as keys in the dictionary variable
with their corresponding values.

9. Select the dictionary variable that you want to use to store the output from the Assign the output to
list.
The dictionary variable stores the output parameters of the Enterprise 11 бот as keys.
Additionally, the following keys are added in the dictionary variable by default:

Key Value

COMMAND Name of the command that was last
executed by the Enterprise 11 бот.

STATUS Status of the Enterprise 11 бот execution.

START_TIME Time when execution of the Enterprise 11
бот started.

END_TIME Time when execution of the Enterprise 11
бот ended.

AUTOMATION_NAME Name of the automation

10. Щелкните Сохранить.

VBScript пакет
The VBScript пакет contains actions that enable VBScript functions in a task.

Перед началом работы

1. Verify that the device on which you want to run the VBScript has Windows operating system installed.
2. Open a VBScript file, or input the script you want to run using the Open action. You must associate

the details of the file or script you want to run with a session name. Use this same session name for
other VBScript actions.

3. Use the Run function action to execute a function within the script or execute the entire script. You
must use the VBScript session name you established in the previous step.

4. After you have executed the script, close the VBScript session.
To review the бот launcher logs, navigate to C:\ProgramData\AutomationAnywhere
\BotRunner\Logs\<current month>\Bot_Launcher-<today's date>.log.zip. Each
zipped folder contains a file with data on the code execution, which is useful for debugging.
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Действия в VBScript пакет

пакет VBScript включает в себя указанные ниже actions.

Прим.:  The Open action must be the first action to use the VBScript in a task.

Действие Описание

Закрыть См. раздел Close action in VBScript.

Выполнить функцию См. раздел Run function action in VBScript.

Открыть См. раздел Open action in VBScript.

Задачи, связанные с данной
Example of using the VBScript package in a resilient bot
Build a bot that executes a Microsoft Visual Basic script. Use the Try/Catch package to gracefully end the
bot if it fails, making it resilient to crashes. A resilient bot allows scheduled and queued bots to continue
even if the current bot encounters an error.

Close action in VBScript
This action enables you to close the session in VBScript.

Настройки

Closes the session.
Specify the same session name from the Open action in VBScript.

Run function action in VBScript
You can run a function within VBScript using the Run function action.

Настройки

Runs a function within the VBScript.
• In the  VBScript  session field, specify a session name. Use the same session name from the Open

action in VBScript.
• Необязательно. Specify the function name to run and the arguments to pass to the function.

Прим.:  You can pass only a list variable as an argument for the function. You can use the list variable
to pass multiple arguments of different data types such as Boolean, datetime, number, and string.

• Необязательно. If the specified function returns a value, specify the variable to store that value
in the Assign the output to variable field. В  отображается описательное имя переменной по
умолчанию. If you create several output variables, subsequent variable names are appended with a
-1, -2, -3, and so on to avoid duplication.

Прим.:  In VBScript, stand alone scripts do not return a value.
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Open action in VBScript
This action enables you to open a VBScript file.

Настройки

Opens a VBScript file.
• In the  VBScript  session field, specify a session name. Use this same session name for other 

VBScript  actions.
• In the  VBScript , choose one of the following options:

• In the Import existing file option, select an existing VBScript file.

Прим.:  If you are uploading a script from a file on your desktop, the file and any dependencies
must be in a standalone folder. When you select a file for upload, all files and folders at the same
folder level are uploaded.

• In the Manual input option, enter the VBScript.

Ожидать пакет
Use the actions in the Ожидать пакет to add a condition to wait for an application screen to change, or a
separate window to open or close before proceeding to the next action.

Действия в Ожидать пакет

пакет Ожидать включает в себя указанные ниже actions.

Действие Описание

Ожидать условие См. Wait for condition action

Ожидать изменения
экрана

См. раздел Using Wait for screen change action.

Ожидать окна См. раздел Using Wait for window action.

Wait for condition action
Makes the бот wait until a specific condition is true before executing the next action.

Настройки

In the Wait till field, specify the condition to meet. For example, the wait condition can be based on
whether an application is running, a folder or file exists, a variable matches the specified value, an
application window exists, or a machine or server is running.

Прим.:
• If a бот encounters an internal error that does on appear on the UI, it does not wait for the amount of

time that is specified in this action. The бот does not stop and continues to the next line.
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• When you create a бот and use the variable option to search the window title and use the condition
Window exists, or Window does not exist the бот will not search for the changed window title.
Also, it will not identify the window title if you have changed the variable. You can use the condition
Window with same title does not exist, or Window with same title exist to verify whether a
window with the same title exists or changed.

This action offers the same conditions as the Если пакет. See the Если пакет.

Using Wait for screen change action
Use the Wait for screen change action to wait for the content of a specific screen or the entire window
to change before executing the next action.
For example, a Human Resources (HR) personnel automating leave-management tasks wants to log in to
the HR portal. After entering the user credentials, this action enables the automation task to wait until the
next screen loads.
1. In the Actions palette, double-click or drag the Wait for screen change action from the Ожидать

пакет.
2. In the Screen change relative to field, choose Window or Screen.
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3. Select an application window:
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Вариант Шаги

Приложение From the drop-down list, select the window title
from the open applications.
• The Window title field displays the title of

the application window you have selected.
Вставьте символ подстановочного знака
(*) в поле Заголовок окна для поиска
заголовков окон, которые могут меняться.
You can specify one or more wildcards (*)
at the start, middle, or end of the value.For
example, to perform an operation on any
window that has Microsoft in the title, use
a wildcard to indicate any string by adding
it before or after the value: *Microsoft*.
The  first searches for the exact window
title (Microsoft), and if it does not find a
match, it searches for windows with the term
Microsoft anywhere in the title.
Вы можете использовать регулярное
выражение (regex) для идентификации
заголовка окна. Select the regular expression
condition as either String or a Pattern and
then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable
the Case sensitive option to match the
letter case, or disable the option to identify a
window title where the letter case does not
match.

Прим.:  Ensure that the minimum  version
installed on your system is the version that
was released with  v.26. If you have a  version
released with  v.25 or earlier, then by default,
the window title will be identified only with
matching letter case (case-sensitive).

For example, you can enter the String
value as ((\w*)-Notepad for all window
title names starting with ((\w*)-
Notepad, or use Pattern value as
((\w)\s)*document-Notepad for only
those window titles that match this pattern.

Прим.:
• When you use a regular expression of

type String with -title as the input
value for a window title in any , the  might
encounter a run time error. To prevent
the run time error, ensure that when you
add the string input as *-title, the
application with the specific title is open.
The asterisk (*) is just a character, not a
wild card character.

• When you use a regular expression of
type Pattern with -title as the input
value for a window title in any , the  might
encounter a run time error because the
input value *-title is incorrect.
Ensure that you use valid regex patterns.

• The Executable field displays the complete
path of the executable file to identify the right
window.
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Вариант Шаги

Браузер Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based
, and  browsers.

Переменная Use a window variable to specify the application
window you want to use.

4. Необязательно: Select the Resize window option to specify the window dimensions.
This option delivers a more reliable бот. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the ботto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Прим.:  This option is available only for windows that can be resized. It is not available for the
Desktop or Taskbar options.

5. Click Capture region.
The selected window appears.

6. Drag the mouse to draw a rectangle around the region that you want to capture and right-click when
done.
The captured area appears in the Preview section, followed by the image coordinates X, Y, Width,
and Height.

7. In the How long to wait before comparing screens? field, specify the wait time (in seconds) to
begin comparing the window or screen.
When a difference is detected, the comparison stops and the task proceeds to the next action.

8. In the How long to wait before screen comparing is stopped? field, specify the wait time (in
seconds) for the screen to change.
If the screen does not change within the time you specified, the task proceeds with the next action.

9. Select the Throw an exception if the screen is not changed option to show an error message
and terminate the бот if the screen does not change.
If the option is deselected and the screen does not change, the task proceeds with the next action.

10. Щелкните Сохранить.

Using Wait for window action
Use the Wait for window action to wait for the specified window to open or close before executing the
next action.
For example, a Human Resources (HR) personnel automating leave-management tasks might require the
attendance application to open before they enter the user credentials. This action enables the automation
task to wait until the application window opens.
1. In the Actions palette, double-click or drag the Wait for window action from the Ожидать пакет.
2. In the Wait for window field, select the option you want the automation to wait for:

• Wait for window to open
• Wait for window to close

3. Select an application window:
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Вариант Шаги

Приложение From the drop-down list, select the window title
from the open applications.
• The Window title field displays the title of

the application window you have selected.
Вставьте символ подстановочного знака
(*) в поле Заголовок окна для поиска
заголовков окон, которые могут меняться.
You can specify one or more wildcards (*)
at the start, middle, or end of the value.For
example, to perform an operation on any
window that has Microsoft in the title, use
a wildcard to indicate any string by adding
it before or after the value: *Microsoft*.
The  first searches for the exact window
title (Microsoft), and if it does not find a
match, it searches for windows with the term
Microsoft anywhere in the title.
Вы можете использовать регулярное
выражение (regex) для идентификации
заголовка окна. Select the regular expression
condition as either String or a Pattern and
then enter the value. By default, the Window
title field is case-sensitive.
To identify a browser title, you can enable
the Case sensitive option to match the
letter case, or disable the option to identify a
window title where the letter case does not
match.

Прим.:  Ensure that the minimum  version
installed on your system is the version that
was released with  v.26. If you have a  version
released with  v.25 or earlier, then by default,
the window title will be identified only with
matching letter case (case-sensitive).

For example, you can enter the String
value as ((\w*)-Notepad for all window
title names starting with ((\w*)-
Notepad, or use Pattern value as
((\w)\s)*document-Notepad for only
those window titles that match this pattern.

Прим.:
• When you use a regular expression of

type String with -title as the input
value for a window title in any , the  might
encounter a run time error. To prevent
the run time error, ensure that when you
add the string input as *-title, the
application with the specific title is open.
The asterisk (*) is just a character, not a
wild card character.

• When you use a regular expression of
type Pattern with -title as the input
value for a window title in any , the  might
encounter a run time error because the
input value *-title is incorrect.
Ensure that you use valid regex patterns.

• The Executable field displays the complete
path of the executable file to identify the right
window.
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Вариант Шаги

Браузер Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based
, and  browsers.

Переменная Use a window variable to specify the application
window you want to use.

4. In the How long you would like to wait for this condition to be true? field, specify the wait
time (in seconds) for the window to open or close.
If the window does not open or close within the time you specify, the task proceeds to execute the
next set of actions.

5. Select the Throw an exception if wait for window is unsuccessful option to show an error
message and terminate the бот if the window does not open or close within the specified amount of
time.
If the option is deselected and the window does not open or close within the specified amount of time,
the task proceeds with the next action.

6. Щелкните Сохранить.

Окно пакет
Use the Окно пакет to automate tasks relating to the window.
Window is a data type available for storing application window titles. It is the only data type that can be
used in all the actions of the Window пакет. Create a variable of data type Window and select or assign
a window title.

Прим.:  When you create a Window type variable, note that selecting Browser as default value supports
only Google Chrome tabs whereas selecting Application as default value supports any application
window.

Use this variable in any number of actions within the automation task. If the application window title
changes, then change the value assigned to the variable. The new application title is reflected in all the
actions where the variable is used.

Действия в Окно пакет

пакет Окно включает в себя указанные ниже actions.

Действие Описание

Активировать См. Activate action in Окно

Присвоить См. Assign action in Окно

Закрыть См. Close action in Окно

Закрыть все См. Close all action in Окно

Получить заголовок
активного окна

См. Get active window title action in Окно

Развернуть См. Maximize action in Окно

Свернуть См. Minimize action in Окно
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Действие Описание

Изменить размер См. Resize action in Окно

Восстановить См. Restore action in Окно

Установить заголовок См. Set title action in Окно

Activate action in Окно
The Activate action in the Окно package enables you to activate a window.

Настройки

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Приложение. Выберите из списка окон, включая окна браузера, которые в настоящее время

открыты на устройстве Bot Creator.
• Браузер. Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based , and  browsers.

• Переменная. Выберите существующую переменную окна, чтобы задать заголовок в
заголовке окна приложения.

• In the Window title field, specify the title.
Вставьте символ подстановочного знака (*) в поле Заголовок окна для поиска заголовков окон,
которые могут меняться. You can specify one or more wildcards (*) at the start, middle, or end of the
value. For example, to perform an operation on any window that has Microsoft in the title, use a
wildcard to indicate any string by adding it before or after the value: *Microsoft*. The  first searches
for the exact window title (Microsoft), and if it does not find a match, it searches for windows with
the term Microsoft anywhere in the title.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
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you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Assign action in Окно
The Assign action in the Окно package enables you to assign a source window variable's value to a
designated window.

Настройки

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Приложение. Выберите из списка окон, включая окна браузера, которые в настоящее время

открыты на устройстве .
• Браузер. Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based , and  browsers.

• Переменная. Выберите существующую переменную окна, чтобы задать заголовок в
заголовке окна приложения.

• In the Select the destination window variable/value field, specify the variable.

Прим.:  The regular expression (regex) is currently not supported.

Close action in Окно
The Close action in the Окно package enables you to close the application window.

Настройки

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Приложение. Выберите из списка окон, включая окна браузера, которые в настоящее время

открыты на устройстве .
• Браузер. Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based , and  browsers.

• Переменная. Выберите существующую переменную окна, чтобы задать заголовок в
заголовке окна приложения.

Вставьте символ подстановочного знака (*) в поле Заголовок окна для поиска заголовков окон,
которые могут меняться. You can specify one or more wildcards (*) at the start, middle, or end of the
value. For example, to perform an operation on any window that has Microsoft in the title, use a
wildcard to indicate any string by adding it before or after the value: *Microsoft*. The  first searches
for the exact window title (Microsoft), and if it does not find a match, it searches for windows with the
term Microsoft anywhere in the title.

© 2023 Automation Anywhere. All rights reserved.     1945



    Automation Anywhere - Сборка

Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна. Select
the regular expression condition as either String or a Pattern and then enter the value. By default, the
Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or disable
the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released with 
v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be identified
only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those window
titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window title

in any , the  might encounter a run time error. To prevent the run time error, ensure that when you add
the string input as *-title, the application with the specific title is open. The asterisk (*) is just a
character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window title
in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Прим.:
• When multiple Excel windows are opened, the бот closes all the open Microsoft Excel windows even

when a specific Excel window name is selected to close.
• When you select Currently active as the window title, to close any active windows, and then run the

бот, the Shut Down Windows pop-up is no longer activated, even if there are no active windows on
the machine.

Close all action in Окно
The Close all action in the Окно package enables you to close all the windows.

Настройки

In the Add window field, you can provide the title of the application windows that you do not want to
close.
You can also search the window titles by using (*) as a wildcard character. Specify one or more (*)
wildcards at the start, middle, or end of the title. For example, to perform an operation on any window that
has Microsoft in the title, use a wildcard to indicate any string by adding it before or after the value:
*Microsoft*. The бот first searches for the exact window title (Microsoft), and if it does not find a
match, it searches for windows with the term Microsoft anywhere in the title.

Прим.:  To keep the Bot editor window open, ensure that you add it in the Add window field. For
example, enter *Control Room | Automation Anywhere* in the window title to keep it open.
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Get active window title action in Окно
The Get active window title action in the Окно package enables you to retrieve the title of the active
window.

Настройки

In the Assign the window title to variable field, specify the variable.
В  отображается описательное имя переменной по умолчанию. If you create several output variables,
subsequent variable names are appended with a -1, -2, -3, and so on to avoid duplication.

Прим.:  The regular expression (regex) is currently not supported.

Maximize action in Окно
The Maximize action in the Окно package enables you to maximize a window.

Настройки

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Приложение. Выберите из списка окон, включая окна браузера, которые в настоящее время

открыты на устройстве .
• Браузер. Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based , and  browsers.

• Переменная. Выберите существующую переменную окна, чтобы задать заголовок в
заголовке окна приложения.

Вставьте символ подстановочного знака (*) в поле Заголовок окна для поиска заголовков окон,
которые могут меняться. You can specify one or more wildcards (*) at the start, middle, or end of the
value. For example, to perform an operation on any window that has Microsoft in the title, use a
wildcard to indicate any string by adding it before or after the value: *Microsoft*. The  first searches
for the exact window title (Microsoft), and if it does not find a match, it searches for windows with the
term Microsoft anywhere in the title.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна. Select
the regular expression condition as either String or a Pattern and then enter the value. By default, the
Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or disable
the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released with 
v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be identified
only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those window
titles that match this pattern.

Прим.:
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• When you use a regular expression of type String with -title as the input value for a window title
in any , the  might encounter a run time error. To prevent the run time error, ensure that when you add
the string input as *-title, the application with the specific title is open. The asterisk (*) is just a
character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window title
in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Minimize action in Окно
The Minimize action in the Окно package enables you to minimize a window.

Настройки

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Приложение. Выберите из списка окон, включая окна браузера, которые в настоящее время

открыты на устройстве .
• Браузер. Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based , and  browsers.

• Переменная. Выберите существующую переменную окна, чтобы задать заголовок в
заголовке окна приложения.

Вставьте символ подстановочного знака (*) в поле Заголовок окна для поиска заголовков окон,
которые могут меняться. You can specify one or more wildcards (*) at the start, middle, or end of the
value. For example, to perform an operation on any window that has Microsoft in the title, use a
wildcard to indicate any string by adding it before or after the value: *Microsoft*. The  first searches
for the exact window title (Microsoft), and if it does not find a match, it searches for windows with the
term Microsoft anywhere in the title.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна. Select
the regular expression condition as either String or a Pattern and then enter the value. By default, the
Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or disable
the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released with 
v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be identified
only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those window
titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window title

in any , the  might encounter a run time error. To prevent the run time error, ensure that when you add
the string input as *-title, the application with the specific title is open. The asterisk (*) is just a
character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window title
in any , the  might encounter a run time error because the input value *-title is incorrect.
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Ensure that you use valid regex patterns.

Resize action in Окно
The Resize action in the Окно package enables you to resize a window.

Настройки

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Приложение. Выберите из списка окон, включая окна браузера, которые в настоящее время

открыты на устройстве .
• Браузер. Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based , and  browsers.

• Переменная. Выберите существующую переменную окна, чтобы задать заголовок в
заголовке окна приложения.

• Вставьте символ подстановочного знака (*) в поле Заголовок окна для поиска заголовков окон,
которые могут меняться. You can specify one or more wildcards (*) at the start, middle, or end of the
value. For example, to perform an operation on any window that has Microsoft in the title, use a
wildcard to indicate any string by adding it before or after the value: *Microsoft*. The  first searches
for the exact window title (Microsoft), and if it does not find a match, it searches for windows with
the term Microsoft anywhere in the title.

• Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

• In the Left, Top, Width, and Height fields, specify values for resizing the window.
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Restore action in Окно
The Restore action in the Окно package enables you to restore a window.

Настройки

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Приложение. Выберите из списка окон, включая окна браузера, которые в настоящее время

открыты на устройстве .
• Браузер. Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based , and  browsers.

• Переменная. Выберите существующую переменную окна, чтобы задать заголовок в
заголовке окна приложения.

• Вставьте символ подстановочного знака (*) в поле Заголовок окна для поиска заголовков окон,
которые могут меняться. You can specify one or more wildcards (*) at the start, middle, or end of the
value. For example, to perform an operation on any window that has Microsoft in the title, use a
wildcard to indicate any string by adding it before or after the value: *Microsoft*. The  first searches
for the exact window title (Microsoft), and if it does not find a match, it searches for windows with
the term Microsoft anywhere in the title.

• Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Set title action in Окно
The Set title action in the Окно package assign a new window title to a window variable.
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Настройки

• In the Window field, select an option: Choose from the Application, Browser, or Variable tab.
• Приложение. Выберите из списка окон, включая окна браузера, которые в настоящее время

открыты на устройстве .
• Браузер. Select from a list of supported browser tabs.

Прим.:  This option supports , Chromium-based , and  browsers.

• Переменная. Выберите существующую переменную окна, чтобы задать заголовок в
заголовке окна приложения.

• In the New window title field, enter the new title.

Прим.:  The regular expression (regex) is currently not supported.

Рабочая нагрузка пакет
The Рабочая нагрузка пакет enables you to insert work items in a queue for workload automation. It also
enables data chaining between multiple queues. You can orchestrate multiple боты, and enable optimal
device utilization through the queueing mechanism of workload management.

For example, a business process of Employee Salary Processing:
• A payroll queue can process the employee salaries, and a payroll бот can add work items to a finance

queue.
• The finance queue in turn can release the funds to employees and a finance бот in turn adds works

items in a HR queue to email employees on the salary processing completion.

You must have the Queue Owner or Participant privileges to view the list of queues in the Рабочая
нагрузка пакет.

Действия в Рабочая нагрузка пакет

пакет Рабочая нагрузка включает в себя описанные ниже action.

Прим.:  If you built a бот using actions from the Рабочая нагрузка пакет from Сборка 5322 or earlier,
the action will be missing when you open the бот with the default пакет version. You must reinsert the
action and repopulate the fields.

Действие Описание

Вставить рабочий элемент Allows you to insert a work item from an
existing queue to another queue as part of a бот
execution.

Понятия, связанные с данным
Управление рабочей нагрузкой
Модуль управления рабочими нагрузками позволяет пользователям загружать файлы Microsoft Excel
и CSV в Control Room, чтобы записи из этих файлов попадали в развертывания бот.
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Задачи, связанные с данной
Attach work item template to TaskBot
Attach a work item template to a TaskBot to use the TaskBot in workload automation.
Use Work Item variables
You can use the Work Item variables to pass the Work Item attributes or values to the TaskBot from the
Control Room when you run the бот with the option Run bot with queue.

Using Insert work item action
The Insert work item action provides you the flexibility to insert a work item to another queue as part of
a бот execution.
• You must have the Queue Owner or Participant privileges to view the list of queues in the Рабочая

нагрузка пакет.
• Ensure that the бот is not connected to a Work item template.

Use the Insert work item to manage complex workflows by configuring a бот to add work items from
multiple queues. For example, use a бот to read a list of invoices from a .csv file and add the invoices due
for payment to another бот that manages information of payments due on specific dates. The automation
can be used in the scenarios where work items are part of a different system (Database, Excel) and the
бот reads them and adds them to a queue or where one queue adds work items to another queue as part
of data chaining.
1. In the Automation page, Create a бот or Edit an existing бот.
2. In the Actions palette, double-click or drag the Insert Work Item action from the Рабочая

нагрузка package.
3. In the Workload: Insert work item window, add parameters such as the Queue and work item

values:
a) Click Browse to select a queue name from the list of queues to insert as a work item.
b) Click Confirm to add the queue.
c) Start entering work item values in the work item fields.

Прим.:  These parameters are populated based on the work item template associated with the
selected queue.

You can also assign a variable value to these parameters by pressing the F2 key and selecting a
variable name from the list.

Совет:  Use UTC format (YYYY-mm-dd 00:00:00) for Date data type.

4. Щелкните Сохранить.
The action is added to the бот.

5. Add more data using the Insert Work Item action.
After the required data is added, Save the бот and Check in the бот to the Public folder for further
processing and deployment.

Понятия, связанные с данным
Создание очередей рабочих нагрузок
A queue is one of the main building blocks of Workload Management. A queue holds data known as Work
Items for further processing. The system distributes these Work Items to individual unattended Bot Runner
in a device pool for processing.
Задачи, связанные с данной
Attach work item template to TaskBot
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Attach a work item template to a TaskBot to use the TaskBot in workload automation.
Use Work Item variables
You can use the Work Item variables to pass the Work Item attributes or values to the TaskBot from the
Control Room when you run the бот with the option Run bot with queue.
Insert Work Items
Add Work Items from an Excel or CSV file to the queue after you define the structure.

XML package
Extensible Markup Language (XML) is a markup language designed to store and transport data. Use the
actions in the XML пакет to automate the processing of XML data generated from web services and cloud
computing applications.
An XML document is structured as an ordered and labeled tree. Each node of the tree is an XML element
and is written with an opening and closing tag. In the following example, custname and custid are nodes:

<customer>
<custname>XYZ Corp</custname>
<custid>A001</custid>
</customer>

XPath is a query language that uses path expressions to select nodes or node-sets in an XML document.
XPath includes built-in functions for manipulation of string, numeric, Boolean, date and time, and so on.

Перед началом работы

Perform the following actions within the XMLпакет.
1. Start the XML session using the Start XML Session action. Use this session name for all

corresponding actions.
2. Use the different actions available in the XML пакет to automate XML-related tasks.
3. Save the session using the Save XML Session action to assign the data to a file or String-type

variable.
4. End the session using the End XML Session action to complete a task.

Действия в XML пакет

The XML includes the following actions:

Действие Описание

Удалить узел См. раздел Delete node action in XML.

Завершить сеанс См. раздел End session action in XML.

Выполнить функцию
XPath

См. раздел Execute XPath function action in XML.

Получить несколько
узлов

См. раздел Get multiple nodes action in XML.

Получить один узел См. раздел Get single node action in XML.

Вставить узел См. раздел Using Insert node action.
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Действие Описание

Сохранить данные
сеанса

См. раздел Save session data action in XML.

Начать сеанс См. раздел Start session action in XML.

Обновить узел См. раздел Update node action in XML.

Проверить документ
XML

См. раздел Validate XML document action in XML.

Delete node action in XML
The Delete node action in the XML пакет enables you to delete a specific node from XML file.

Настройки

• Enter the session name or select an existing variable used in the Start XML session action.
• Enter the XPath expression for the node to be deleted.
• Enter the attribute (optional).

End session action in XML
The End session action in the XML пакет enables you to close an XML session.

Настройки

Enter the session name or select an existing variable used in the Start XML session action .

Прим.:  The End session action clears out session-related data from memory. To save the modified data,
use the Save session data action.

Execute XPath function action in XML
The Execute XPath function action in the XML пакет enables you to execute XPath function and store
the results in a variable.

Настройки

• Enter the session name or select an existing variable used in the Start XML session action.
• Enter the XPath expression or select an existing variable.
• Assign a String-type variable to the output.

Get multiple nodes action in XML
The Get multiple nodes action in the XML пакет enables you to retrieve the value of multiple nodes.

Настройки

• Enter the session name or select an existing variable used in the Start XML session action.
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• Enter the XPath expression to retrieve multiple nodes or select an existing variable.
• In the Get each node field, select if you require the Text value, XPath expression, or Specific

attribute name of each node.
Например:

<Customer>
<Cust_Details>
 <custid>A001</ custid>
<custname>XYZ Corp</custname>
<custzipcode>15639</custzipcode>
<country>Mexico</country>
<Locale lang=”es”> Spanish</Locale>
</Cust_Details>
</Customer>

• Text value retrieves the exact value of the specific node element. For example, the custname
element of a Cust_Details node retrieves the names of all the customers of the company.

• XPath expression refers to the path of the selected node in an XML document. An XPath expression
such as Customer//Cust_Details//custid selects only customer IDs that are available in the
customer details node.

• Specific attribute defines a property or the type of the element in a particular node. For example,
lang is an attribute of the Locale element in a Cust_Details node. The output for lang
attribute is displayed as es.

Get single node action in XML
The Get single node action in the XML пакет enables you to retrieve the value of a single node.

Настройки

• Enter the session name or select an existing variable used in the Start XML session action.
• Enter the XPath expression, and attribute (optional) to retrieve a node.

Get single node retrieves the first value from the XML document based on the provided XPath
expression and the attribute. Например:

<Customer>
<Cust_Details>
 <custid>A001</ custid>
<custname>XYZ Corp</custname>
<custzipcode>15639</custzipcode>
<country>Mexico</country>
<Locale lang=”es”> Spanish</Locale>
</Cust_Details>
</Customer>

• Xpath expression with attribute: The attribute value of the XPath expression element is displayed.
For example, if the XPath expression is entered as Customer//Cust_Details//Locale with the
attribute as lang, the output is displayed as es.

• XPath expression without attribute: The value of the XPath expression element is displayed. For
example, if the XPath expression is entered as Customer//Cust_Details//Locale without any
attribute, Spanish is displayed as an output.

• Assign the output to a String-type variable.
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Using Insert node action
Use this action to insert a node in an existing XML file and assign it to a value. Optionally, assign a name
space and attributes to the node.
To insert a node, do the following:
1. Enter the session name.

Use the name of the session that you have used in the Start XML session action.
2. Specify an XPath expression to indicate where to insert the new node.
3. Enter a node name.
4. Enter a value for the node.
5. If the node name exists, select from the following options:

• Insert it anyways
• Skip it
• Overwrite it

6. Specify the location to insert the node from the following options:
• Beginning of the child nodes
• End of the child nodes
• Before specific child note
• After specific child node

If Before Specific child node or After Specific child node is selected, specify the child node
name before or after which the node must be inserted.

7. Необязательно: Enter the default name space to be mapped to the node.
8. Enter the attributes using a Dictionary-type variable.

Create a new variable of type Dictionary or use one that already exists.
9. Необязательно: Enter the attribute name space using a Dictionary-type variable

Create a new Dictionary-type variable or use one that already exists.
10. Щелкните Сохранить.

Save session data action in XML
The Save session data action in the XML пакет enables you to save the XML session data to a file or
variable of type String.

Настройки

• Enter the session name or select an existing variable used in the Start XML session action.
• To save the session data to a file, select the Write XML data option and specify a file path.
• Select Overwrite to replace the existing file if a file with the same name exists in the location you have

specified.
• Assign the output to a String-type variable.

Прим.:  The session data will be saved if you select the Write XML data option.

© 2023 Automation Anywhere. All rights reserved.     1956



    Automation Anywhere - Сборка

Start session action in XML
The Start session action in the XML пакет enables you to create a new XML session based on an XML file
or specified text.

Настройки

• Start the XML session.
• Enter the session name or select an existing variable used in the Start XML session action. Use this

session name for all corresponding actions.
• In the Data Source field, select either File or Text:

• Файл. Select from the Control Room file, Desktop file, or an existing Variable of File type.
• Текст. Specify the text name or select an existing variable.

• Save the XML session.

Update node action in XML
The Update node action in the XML пакет enables you to update the value of a node.

Настройки

• Type the session name or select an existing variable used in the Start XML session action.
• Enter the XPath expression for the node to be updated.
• Enter a New value for the node.
• Select the Updates attribute (s) option to create a new Dictionary or to add an existing Variable

of Dictionary-type.

Validate XML document action in XML
The tags and document structure are defined when the XML document is created. Use the Validate XML
document action in the XML пакет to validate an XML document.

Настройки

• Enter the session name or select an existing variable used in the Start XML session action.
• Select the validation type from the following options:

• XML schema files (.xsd)
• Список. Specify the schema XSD file path you want to validate in the Value field. Click Add to

add multiple XML schema files (.xsd).
• Variables: Create a new variable of type List with subtype String and enter the XSD file path in

the Default value field (optional) or use an existing variable.

• Internal Document Type Definitions (DTDs)
• Well formed

• Assign the output to a variable using Assign the output (Valid or Invalid) to variable
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Example for using actions in XML пакет
Using the XML пакет, create a бот that reads and writes data from an XML file to an Excel sheet.
The sample XML used in this tutorial has the following structure:

<movies>
    <movie genre="" year="">
        <name></name>
        <description></description>
        <director></director>
        <writers>
            <writer type=""></writer>
            <writer type=""></writer>
        </writers>
        <rating>R</rating>
    </movie>
</movies>

Before you begin, download a sample XML file.

The tutorial is intended to demonstrate the following actions:
• Use an XPath expression to get a node set with specific value and iterate through the items in the node

set, for example, movies with specific rating in this tutorial.
• Use an XPath function to iterate through the child node sets.
• Concatenate variables to build a string.
• Write data to an Excel sheet.

Ensure the following:
• You know how to create боты.
• You are familiar with the Control Room user interface.

1. Create a бот and name it XMLDataReader.

2. Add a step to group all tasks for opening an Excel sheet.
a) Add the Step > Step action after the Start flow in the Bot editor.

Прим.:  To add an action, search for the action in the Actions pane and drag it to the бот flow
in the Bot editor.

b) In Title, enter Open an Excel Sheet and save the action.

3. To create and open an Excel sheet, use Excel advanced > Create workbook.
a) Add the Excel advanced > Create workbook action within the Step action.
b) In File path, enter C:\movies\movies.xlsx, and save the action. If the movies folder does

not exist in the specified path, create a movies folder in the path.
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4. To select the first cell on the Excel sheet, use the Excel advanced > Go to cell action.
a) Add the Excel advanced > Go to cell action after the Excel advanced: Create workbook

action.
b) Click Specific cell if it is not already selected, and enter A1.
c) Save the action.

5. Create another step to group all the tasks for retrieving XML data.
a) Add the Step > Step action after the first Step action.
b) In Title, enter Get XML Data and save the action.

6. Start an XML session.
a) Add the XML > Start session action within the Get XML Data step.
b) Under File, select Desktop, browse and select the sample XML file that you downloaded.
c) Сохраните изменения.

7. To get all movie nodes with rating R, use the Get multiple nodes action.
a) Add the XML > Get multiple nodes action after the Start session action.
b) In XPath Expression, enter //movie[rating/text()='R'], and save the action.

The selected node set is stored in a system variable and is available to the For each Node in a
XML dataset iterator now.

c) To ensure that the action retrieves the entire node set instead of just the text nodes, click Xpath
expression.

8. Use the Loop action to iterate through the selected node set that the Get multiple nodes action
retrieves.
a) Add Loop > Loop after the XML: Get multiple nodes action.
b) Under Iterator, select XML > For each Node in a XML dataset as the iterator.
c) In Assign the current row to this variable, click (x) and create a variable with the default

name, for example, XMLNode. Each item in the node set is now available through the variable.
d) Сохраните action.

9. To get the movie name from the iterated node, use the Get single node action.
a) Add the XML > Get single node action within the Loop: Loop action.
b) In XPath expression, enter $XMLNode$/name.
c) In Assign the output to variable, create a variable and name it sMovieName.
d) Сохраните action.

10. To write the movie name from the XMLNode variable, use the Set cell action.
a) Add the Excel advanced > Set cell action after the Get single node action.
b) Click Active cell, enter $sMovieName$ in Cell value, and save the action.
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11. To select a new cell within the Excel sheet, use the Go to cell action.
a) Add the Go to cell action after the Set cell action after the Excel advanced: Set cell action.
b) Click Active cell, select One cell to the right, and then save the action.

12. To get the director name from the iterated node, use the Get single node action.
a) Add the XML > Get single node action after the Excel advanced: Go to cell action.
b) In XPath expression, enter $XMLNode$/director.
c) In Assign the output to variable, create a variable with the following name: sDirector
d) Сохраните action.

13. To write the director name from the XMLNode variable, use the Set cell action.
a) Add the Excel advanced > Set cell action after the XML: Get single node action.
b) Click Active cell, enter $sDirector$ in Cell value, and save the action.

14. To select a new cell within the Excel sheet, use the Go to cell action.
a) Add the Go to cell action after the Excel advanced: Set cell action.
b) Click Active cell, select One cell to the right, and then save the action.

15. Because the<writers>node can contain multiple<writer>nodes, get each writer name,
concatenate the names, and write them to a single cell instead of writing values to multiple cells. To
do so, add the Loop action within the current Loop action.
a) To get the number of the<writer>nodes within the<writers>node, add the XML > Execute

XPath function after the Excel advanced: Set cell action. In XPath expression, enter
count($XMLNode$/writers/writer). In Assign the output to variable, create a variable
named sWriterCount.
You will use the<writer>node count to loop through all the<writer>nodes.

b) Add the Loop > Loop action after the XML: Execute XPath function action.

Важное замечание:  The second Loop action must be added within the main Loop action.

c) Under Iterator, select For n times as the iterator.
d) In Times, enter the following: $sWriterCount.String:toNumber$

Прим.:  sWriterCount contains a string value. To convert string to number, you can use the
$<variable name>.String:toNumber$ format, for example, $sWriterCount.String:toNumber$.

e) In Assign the current value to variable (optional), create a variable named Counter.
f) Сохраните action.
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16. To concatenate the values from all writer nodes, create a string variable.
a) In the Variables pane, click the plus icon.

The Create variable window opens.
b) In Type, select String.
c) In Name, enter sWriters.
d) Click Create.

17. To get the value from the iterated<writer>node, use the Get single node action.
a) Add the XML > Get single node action within the second Loop action.
b) In XPath expression, enter $XMLNode$/writers/writer[$Counter.Number:toString

$].
Using the Counter variable, you can access a node at a specific index. Note that because the
Counter variable contains a numeric value, the .Number:toString$ expression is added to the
Counter variable to convert it to a string.

c) In Assign the output to variable, create a variable and name it sWriter.
d) Сохраните action.

18. To assign values from the writer nodes, use the String > Assign action.
a) Add String > Assign action after the XML: Get single node within the second loop.
b) In Select the source string variable(s)/ value (optional), enter $sWriters$, $sWriter

$.
c) In Select the destination string variable, select sWriters.
d) Сохраните action.

After the inner loop is complete, the sWriters variable will contain all the writer names.

19. To write the writer names to a new cell, use the Excel advanced > Set cell action within the main
loop.
a) Add the Excel advanced > Set cell action after the inner Loop action within the first Loop

action.
b) Click Active cell.
c) Enter $sWriters$ in Cell value.
d) Сохраните action.

The data retrieved from one<movie>node is written to a row. To write the data from the
next<movie>node, you must select the next row in the Excel sheet.

20. To move the cursor to the next row, use the Excel advanced > Go to cell action.
a) Add the Go to cell action after the Set cell action.
b) Click Active cell, select Beginning of the row, and then save the action.
c) Add the Go to cell action again. Click Active cell, select One cell below, and then save the

action.
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21. Before the next node in the retrieved<movie>node set is iterated, you must reset the sWriters
variable. To reset the sWriters variable, perform the following steps:
a) Add the String > Assign action after the Excel advanced: Go to cell within the main loop.
b) Leave Select the source string variable(s)/ value (optional) blank.
c) In Select the destination string variable, select sWriters.
d) Сохраните action.

22. Create a new step.
a) Add the Step > Step action after the second Step action.
b) In Title, enter Close the file.

23. To close the Excel sheet, use Excel advanced Close action.
a) Add Excel advanced > Close within the Close the file step.
b) Сохраните изменения.

24. Run the бот.

Get started with recorders
You can use two recorders in Automation 360, the Universal Recorder and the AISense Recorder, to
automate tasks by recording interactions with objects such as click, read (data extraction), and write (data
entry).

An integrated Средство записи

In versions 2.0.9-20201105-164103 and later, the Средство записи пакет contains both the Universal
Recorder and AISense Recorder. This offers the following benefits:
• Feature updates are delivered as delta updates, which reduces the time spent downloading the newest

Средство записи пакет each release.
• The Start recording icon serves as a common entry point to both recorders.

Прим.:  The AISense Recorder fails if you manually upgrade the Средство записи пакет version, such as
by importing a бот that contains the integrated Средство записи пакет (Version A2019.17 and later) to
a Control Room that has a build from Version A2019.16 or earlier. Always upgrade the Средство записи
пакет through the Control Room. Do not attempt to manually upgrade by importing a .jar file or бот.

Choosing which recorder to use for your task

Before you start building your бот, decide which recorder best fits your requirements.

Universal Recorder Используйте Universal Recorder, если вам
нужно записать такие действия, как щелчок,
чтение или запись, связанные с объектами
пользовательского интерфейса в вашем
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бизнес-приложении. После записи объекта
вы можете указать требования в отношении
action, которое должно быть выполнено с этим
объектом.
Например, если вы записали гиперссылку, вы
можете выбрать действие, чтобы щелкнуть по
ссылке или извлечь текст ссылки. Аналогичным
образом, если вы записываете объект таблицы,
вы можете указать нужное действие: либо
извлечь общее число строк из объекта таблицы,
либо извлечь каждую строку по очереди и
применить к ней нужные actions. Это наиболее
надежная форма автоматизации, поскольку она
применяется к объектам пользовательского
интерфейса, а не к координатам, изображениям,
нажатиям клавиш и т. д.

AISense Recorder Используйте AISense Recorder, если вы создаете
и автоматизируете своих боты в приложениях,
которые открыты через Citrix или доступны
через RDP. Вы также можете сократить время,
затрачиваемое на создание и автоматизацию
ваших боты для приложений предыдущих
версий, где объектно-ориентированная
автоматизация затруднена.
Устойчивость средства записи к разрешению
экрана, браузерам и изменениям
пользовательского интерфейса позволяет
сократить число ограничений и препятствий при
записи задач в бизнес-приложениях.

Universal Recorder for object-based automation
Use the Universal Recorder to record interactions, such as click, read (data extraction), and write (data
entry), with user interface (UI) objects on the desktop, taskbar, or in an application or browser window.
The earlier Automation Anywhere RPA products such as Version 11.3 have three separate recorders to
capture objects from various environments. Automation 360 combines the capabilities of these three
recorders into the Universal Recorder to streamline the recording process.

Using the Universal Recorder

You can use the Universal Recorder in the following ways:
1. To record a process consisting of multiple steps, use the Universal Recorder video camera icon, which

is located on the top-left of the workbench.
Depending on where you want to add newly captured actions in an existing TaskBot, use one of the
following ways:
• To add newly captured actions below an existing action, select the existing action and then start

recording.
• To add newly captured actions before the existing actions that are available inside another action,

select the other action and then start recording. For example, if you want to add newly captured
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actions before the existing actions that are available inside a loop action, select the loop action and
then start recording.

Прим.:  If you do not select any action, then the newly captured actions are added at the end of the
TaskBot by default.

См. раздел Record a task with the Universal Recorder.
2. To record a single interaction that you want to add into an existing TaskBot (for example, if you

missed a step when recording a task), use Capture action from the Средство записи пакет.
См. раздел Using the Capture action.
For a common use case, see Example of entering data into a web form from a worksheet.

The Universal Recorder is also used within actions to capture coordinates (Mouse > Click action) or a
local file path (Application > Open program/file action).

Фоновая обработка

Background processing enables an automation that involves interacting with an application in the
foreground (such as mouse clicks) to run in the background. We recommend that you use the option to
run in background to increase the visibility of the target object and improve бот accuracy. The following
actions support background processing:
• Щелчок
• Установить текст
• Получить текст

Задачи, связанные с данной
Record a task with the Universal Recorder
Use the Universal Recorder to capture a series of interactions (clicks, keystrokes, and mouse movements)
with object controls including text boxes, buttons, tables, menus, radio buttons, combo boxes, check
boxes, list views, links, trees, and page tabs.
Edit a task recorded with the Universal Recorder
After recording a task, edit the Capture actions to change the window, capture a different object, select a
new action, enable background processing, enter a different wait time, or save the output to a variable.
Ссылки, связанные с данной
Требования к браузеру для доступа к Рабочая область RPA
Доступ к интерфейсу Рабочая область RPA из браузера. After you have installed and enabled
extensions in the browser, perform several tasks through the Рабочая область RPA interface based on
your user role and automation requirements.
Secure recording mode
Если включен режим безопасной записи, то боты не записывают значения определенных свойств
и не сохраняют образы приложений. This ensures that sensitive data is not stored in the боты. This
setting only applies to боты that are created or edited after the mode is enabled.
Recording tasks in applications that run on JRE
Use the Universal Recorder to capture objects from Java applet, web start, and desktop applications that
run using Java Runtime Environment (JRE) 6, 7, 8, 9, 10, and 11.
Пакет Средство записи
Средство записи пакет захватывает серию задач в ходе их выполнения, а затем автоматизирует
их. Вы можете автоматизировать работу своих бизнес-приложений (например, настольных и
веб-приложений, приложений SAP и Java) с помощью функции Средство записи для записи

© 2023 Automation Anywhere. All rights reserved.     1964



    Automation Anywhere - Сборка

actions, выполняемых с объектами приложений, например с текстовым полем, кнопкой, таблицей,
переключателем, комбинированным полем и представлением списка.
Actions performed on objects captured with Universal Recorder
After capturing the object, specify the action for the бот to do to the object at runtime. Например, если
вы записали гиперссылку, вы можете выбрать действие, чтобы щелкнуть по ссылке или извлечь
текст ссылки. Refer to the table below for the objects and their possible actions.

Record a task with the Universal Recorder
Use the Universal Recorder to capture a series of interactions (clicks, keystrokes, and mouse movements)
with object controls including text boxes, buttons, tables, menus, radio buttons, combo boxes, check
boxes, list views, links, trees, and page tabs.
• To use the Средство записи, you must already have done the following:

• Установка Bot Agent и регистрация устройств
• Set user device credentials

• Configure device display and font scale to 100%.
If you are using Средство записи пакет version 2.0.6-20200626-193519 or later, you can record tasks
in Google Chrome, Internet Explorer, Java, Microsoft Active Accessibility, and Microsoft UI automation
applications on a computer that has display scale configured to 100%, 125%, or 150%.

• If you are automating a task using a browser, configure the zoom level to 100%.
If you are using Средство записи пакет version 2.0.6-20200626-193519 or later, you can record tasks
in a Google Chrome browser that does not have a zoom level setting of 100%.

• If you are automating a task using a Google Chrome browser, ensure that the Automation Anywhere
plug-in that corresponds with the Automation 360 build version is enabled.

Требования к браузеру для доступа к Рабочая область RPA
• To automate web applications running on Microsoft Edge Chromium browser in Internet Explorer mode

using the Universal Recorder, ensure that the Internet Explorer compatibility mode is enabled. The
objects on the web applications are captured using HTML technology. To enable this mode, perform the
following steps:
1. On the Microsoft Edge Chromium browser page, click Settings.
2. On the left panel, click Default browser.
3. Navigate to the Allow sites to be reloaded in Internet Explorer mode option and select

Allow.
4. Click Add to add the URL of the page that you want to load in Internet Explorer mode.

Прим.:  The pages that you add open in Internet Explorer mode for 30 days from the date when
you add the page.

Considerations when recording a task:
• Use clicks when possible rather than shortcut keys.

When you click an object using the Средство записи, it retrieves the object's properties that enable the
бот to identify the object at runtime. Keyboard shortcuts are less reliable, so use them when it is not
possible to automate the task by a clicking an object.

• If you are automating a task using a browser, do not use autofill to enter values into fields.
• Record the task at low speed.
• Avoid dragging windows during the recording process.
• Avoid clicking on applications that are not part of the process you are recording and automating.
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• When Internet Explorer is used, the action waits until the browser is completely rendered and is in a
ready state before executing the action.

To record a task using the Universal Recorder, follow these steps:
1. From Automation Anywhere web interface left panel, click Automation.
2. Create a new бот or open an existing бот for which you want to record a task.
3. Click Start recording.

Прим.:  In versions 2.0.9-20201105-164103 and later, the Средство записи пакет contains both the
Universal Recorder and AISense Recorder.
An integrated Средство записи

The Automation Anywhere Recorder window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click Universal Recorder.
6. Perform the steps in the task. For example, click buttons, fill in forms, or search a website.

To perform an action on an object, move the mouse pointer on that object. The object is highlighted
with a box. If the box does not appear, verify that you have enabled the necessary plug-in. For more
information, see Universal Recorder supported applications and browsers.
The Recorder window contains the number of operations recorded and a description of the most
recently captured object. For example, 5. Left click on button 'Submit'.
To redo the previous object capture, click the Delete icon at the bottom right of the Recorder
window to discard the most recent capture.
If Secure recording mode is enabled, a shield icon appears to the right of the red recording icon.
Secure recording mode

7. Click Finish after you finish capturing all the necessary objects.
A Capture action is generated for each operation.
Where applicable, the Recorder generates variables. Your variables (user-defined)

8. Edit the actions or click Save.
Edit a task recorded with the Universal Recorder

Edit a task recorded with the Universal Recorder
After recording a task, edit the Capture actions to change the window, capture a different object, select a
new action, enable background processing, enter a different wait time, or save the output to a variable.
Select the List view to see the full details of each action.
Edit a recorded task to do the following:
• Change the application window in which you want to perform the operation, or add a wildcard to the

window title.
• Change the properties of the captured objects.
• Specify the action you want to perform on the captured objects.
• Introduce a delay before the next action is performed.
• Specify the variable you want to use to store the output.

To add a Capture action to the task, see Using the Capture action.
To edit a recorded task, perform the following steps:
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1. Open the бот that contains the recorded actions you want to edit.
2. Click the Capture action that you want to edit.
Make the following changes, as necessary:
3. Change the window selection to the Currently active window option.
4. Необязательно: Вставьте символ подстановочного знака (*) в поле Заголовок окна для поиска

заголовков окон, которые могут меняться. You can specify one or more wildcards (*) at the start,
middle, or end of the value.
For example, to perform an operation on any window that has Microsoft in the title, use a wildcard
to indicate any string by adding it before or after the value: *Microsoft*. The  first searches for
the exact window title (Microsoft), and if it does not find a match, it searches for windows with the
term Microsoft anywhere in the title.
Вы можете использовать регулярное выражение (regex) для идентификации заголовка окна.
Select the regular expression condition as either String or a Pattern and then enter the value. By
default, the Window title field is case-sensitive.
To identify a browser title, you can enable the Case sensitive option to match the letter case, or
disable the option to identify a window title where the letter case does not match.

Прим.:  Ensure that the minimum  version installed on your system is the version that was released
with  v.26. If you have a  version released with  v.25 or earlier, then by default, the window title will be
identified only with matching letter case (case-sensitive).

For example, you can enter the String value as ((\w*)-Notepad for all window title names starting
with ((\w*)-Notepad, or use Pattern value as ((\w)\s)*document-Notepad for only those
window titles that match this pattern.

Прим.:
• When you use a regular expression of type String with -title as the input value for a window

title in any , the  might encounter a run time error. To prevent the run time error, ensure that when
you add the string input as *-title, the application with the specific title is open. The asterisk (*)
is just a character, not a wild card character.

• When you use a regular expression of type Pattern with -title as the input value for a window
title in any , the  might encounter a run time error because the input value *-title is incorrect.
Ensure that you use valid regex patterns.

Прим.:  During runtime, verify that the TaskBot identifies the correct window. If it does not, do the
following:
a. Open the application or browser window.
b. Drag a Window > Get active window title action above the Recorder > Capture action.
c. Insert a string variable into the Assign the window title to variable field.
d. Drag a Window > Set title action below the Window > Get active window title action.
e. In the Window field, insert the window variable generated by the Recorder > Capture action.
f. In the New window title field, insert the string variable from the Get active window title

action.
g. Щелкните Сохранить.
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5. Необязательно: Select the Resize window option to specify the window dimensions.
This option delivers a more reliable бот. It resizes the window to the dimensions at which the task was
recorded, which enhances the ability of the ботto identify the target object.
• If the window is maximized when you record the task, this option is not selected.
• If the window is not at the maximum size when you record the task, this option is selected, by

default, and the width and height fields are automatically filled with the dimensions of the window.

Прим.:  This option is available only for windows that can be resized. It is not available for the
Desktop or Taskbar options.

6. Review the Object properties table.
Following are the list of object properties that are selected by default based on the technology type:

Important:  The following list does not include all the properties and is restricted to the most
commonly used and important properties based on the technology type

Technology type Свойства объекта Описание

Тип элемента
управления

This is a read-only property that shows the type
of object captured, for example, text box or
button.

HTML Technology

DOMXPath It is the path that is used to locate the control or
object that is captured. DOMXPath can be of
two types: Relative XPath and Absolute XPath.
• Absolute Xpath: It contains the complete

path from the root element to the desired
element. For example, an absolute Xpath
for this topic would be /html/body/div/
div[1]/main/div[2]/div/div/div[2]/
div/div/div[1]/div/article/main/
article/div/p[1]

• Relative Xpath: This is a shorter path that
refers to an element you want to identify.
A relative path starts with a // symbol.
For example, the relative XPath for this
topic would be //*[@id="cloud-using-
recorder-action"]/div/p[1]

For example, if you want to find the DOMXPath
of a particular element on Google Chrome
browser, perform these steps:
a. Select the element for which you want to

extract the XPath.
b. Right-click the element and select Inspect.
c. Right-click the highlighted element in the

Element tab.
d. Go to Copy > Copy Xpath to copy the

relative path and select Copy > Copy full
Xpath to copy the absolute path.
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Technology type Свойства объекта Описание

Путь It is a numeric representation of the position
of a particular control in an application. For
web applications, the best practise is to use
DOMXPath from the search criteria when
comapred to Path.

HTML name and
ID

These properties are used to identify an HTML
object

HTML inner text The DOM innerText Property is used to set or
return the text content of a specified node and its
descendants

HTML tag HTML tags are like keywords that define the
way web browser formats and displays the
content. For example, if the captured text has an
HTML code: <h3 class="search_results-
title">Search results for ״string
 package״</h3>, then enter h3 in the HTML
tag field.

Тип элемента
управления

This property is used only as a reference to
ensure that the correct object is captured

Путь It is a numeric representation of the position of a
particular control in an application

Имя This specifies a name of an element and works as
an identifier

Microsoft Active
Accessibility

Идентификатор This specifies the ID of an element and works as
an identifier

Тип элемента
управления

This property is used only as a reference to
ensure that the correct object is captured

Java Technology

Путь It is a numeric representation of the position of a
particular control in an application

Тип элемента
управления

This property is used only as a reference to
ensure that the correct object is captured

Путь It is a numeric representation of the position of a
particular control in an application

Имя This specifies a name of an element and works as
an identifier

Microsoft UI
Automation

Идентификатор This specifies the ID of an element and works as
an identifier

Тип элемента
управления

This property is used only as a reference to
ensure that the correct object is captured.

Путь It is a numeric representation of the position of a
particular control in an application.

Microsoft UI
Automation (COM)

Имя This specifies a name of an element and works as
an identifier.
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Technology type Свойства объекта Описание

Идентификатор This specifies the ID of an element and works as
an identifier.

The бот uses the selected properties to identify the object control at runtime.
a) Verify that the Control Type matches your intended object.

For example, when capturing a table from a website, ensure the Control Type and HTML Tag
values are Table.
If the Control Type does not match your intended object, recapture the object control.

b) Select and assign values to the object properties that you want to include in the object search.
For a more reliable бот, we recommend that you select only the properties that have static values
(such as Name, Class, Type, HTML ID, and DOMXPATH), and deselect the properties that
have dynamic values (such as HTML Href, Path or Value), which are subject to change and
cause бот errors.
It is a best practice to use the wildcard character (*) or variable in object property values to
search for objects whose properties are dynamic and changes frequently.

7. Select the Action from the drop-down list.
For a full list of possible actions by object, see Actions performed on objects captured with Universal
Recorder.
• If you record a click and keystrokes in a text box with a Control Type of Password text, the

Recorder does not capture the keystrokes entered into the field. Instead, the action selects the
Set text option and offers options to securely input the password. We recommend that you store
the password in the Credential Vault and insert it into the action as a credential. Credentials and
credential variables in the Bot editor

If you navigate to the text box using the TAB keystroke instead of a click in an MSAA or SAP
application, the Recorder is able to identify fields with a Control Type of Password text.
We recommend that you use the Set text action without setting a delay time to enter keystrokes
into a text field. However, if the text that you want to enter consists of a control key value or a text
field requires any key press event, then you must set a delay time between the keystrokes when
using the Set text action.

• If the selected Action supports background processing, a Run in the background option
appears. Фоновая обработка

8. Необязательно: Enter a value in the Wait for control field to specify the number of seconds the бот
must wait for the object control to appear on the application window.

9. Необязательно: Assign the output to a variable.
The Control Room suggests a descriptive default variable name based on the action you
selected in step 8. For example, if you selected Get property, the suggested output variable is
PropertyValue. If you create several output variables, subsequent variable names are appended
with a -1 to avoid duplication.

10. Perform the Steps 3 through 9 for the other actions that you want to edit in the бот.
11. Щелкните Сохранить.

Link an object to a supporting anchor

Прим.:  You can use object anchoring in Microsoft Active Accessibility, Microsoft UI Automation, or Java
applications.
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At runtime, if the бот cannot reliably identify an object, link it to a nearby object (such as a link or button)
that is easier for the бот to find:
1. Open the Capture action.
2. Click the Anchor tab.
3. Click Capture anchor.

The browser or application window activates with the main object highlighted (the object that you
previously captured). A dialog box appears, verifying whether the action has correctly identified the
main object.

4. If the correct object is highlighted, click Yes, Select anchor.
Otherwise, click No, I need to correct it to select the correct object.

5. Select a nearby object to the target object that is easier for the бот to find.
The object is highlighted with an anchor icon on the right of the object.

6. Click Save.

Universal Recorder supported applications and browsers
Use the Universal Recorder to record interactions with objects from the supported technologies.

Приложения • Приложения HTML
• Java applet, web start, and desktop applications

that run using Java Runtime Environment
(JRE) 6, 7, 8, 9, 10, and 11 (32-bit and 64-bit
versions)
См. раздел Recording tasks in applications that run
on JRE.

• Microsoft Active Accessibility and UI automation
• Microsoft Silverlight version 5 (standard

Microsoft controls only)
• Oracle EBS and Forms
• SAP versions 730, 740, 750 patch 9, 760 patch

5, and 770 patch 6
• Citrix Virtual Apps
• Electron

Technologies • Microsoft Active Accessibility (MSAA)
• Microsoft UI automation

Прим.:
Silverlight technology is supported for migrated
боты only. You can migrate any Enterprise 11 боты
that you created using Silverlight technology to
Automation 360. To modify the migrated боты
or create new боты to automate Silverlight web
applications, you can capture the web application
using Microsoft UI Automation technology. Microsoft
UI automation supports only standard controls for a
Silverlight application.
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Браузеры • Google Chrome (versions 91 and later) for
Manifest V3 extension

• Google Chrome (versions 90 and earlier) for
Manifest V2 extension
To build and run боты that contain actions from
the Средство записи пакет, you must enable
the Google Chrome extension that corresponds
with the Средство записи пакет version. See
Google Chrome browser extension requirements.
If you encounter an error when recording or
running a бот that automates tasks in a Google
Chrome browser and you have installed Google
Chrome, you must perform additional steps
to configure your system. See Google Chrome
extension troubleshooting.

• Internet Explorer (версия 11)
• Microsoft Edge (version 91 and later) for

Manifest V3 extension
• Microsoft Edge (version 90 and earlier) for

Manifest V2 extension
• Microsoft Edge based on Chromium (versions 79

and later)
Microsoft Edge is supported on Средство записи
пакет version 2.0.9-20201105-164103 and later.
You must install the A2019 plug-in for Microsoft
Edge and verify that it is running in the Task
Manager: Automation 360 extension for Microsoft
Edge

Прим.:  Ensure that the Google Chrome
extension is not installed in the Microsoft Edge
browser because that configuration causes
recording and runtime errors. Google Chrome
extension installed in Microsoft Edge

• Mozilla Firefox (versions 80 and later)
Mozilla Firefox is supported on Средство записи
пакет version 2.0.11-20210128-034104 and
later. You must install the A2019 extension for
Mozilla Firefox: Automation 360 extension for
Mozilla Firefox

Рабочий стол The desktop refers to the device screen when all
application and browser windows are minimized.

Панель задач The taskbar is the horizontal or vertical bar
containing icons of open applications and browsers,
as well as the notification area. You can capture
application, browser, and system icons, such as
Clock and Calendar, volume, and Wi-Fi.

UI objects См. раздел Actions performed on objects captured with
Universal Recorder.
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Ссылки, связанные с данной
Actions performed on objects captured with Universal Recorder
After capturing the object, specify the action for the бот to do to the object at runtime. Например, если
вы записали гиперссылку, вы можете выбрать действие, чтобы щелкнуть по ссылке или извлечь
текст ссылки. Refer to the table below for the objects and their possible actions.

Google Chrome browser extension requirements
Ensure the Automation Anywhere Google Chrome extension you are using corresponds with the Средство
записи пакет version in your боты.
Automation Anywhere has created two versions of the Google Chrome extension, based on the
Средство записи пакет version. Automation Anywhere A2019 extension version 1.1.0.1 is the
recommended Google Chrome extension for боты that contain actions from the Средство
записи пакет 2.0.6 and later. Automation Anywhere Google Chrome extension version 11 or 12 is
required only to run боты that contain actions from the Средство записи пакет 2.0.5 and earlier.
Use the table below to verify that your system is running the correct browser agent and Google Chrome
extension.
• Verify the browser agent in the Windows Task Manager > Details tab.

If the browser agent is in the Task Manager, but is not running:
1. Verify that the ComSpec variable is defined in the Environment Variables list.

You can locate this list in My computer > Properties > Advance System Settings >
Environment Variables.

2. If the ComSpec variable is not in the list, define it by specifying the Variable Name as ComSpec
and the Variable Value as %SystemRoot%\system32\cmd.exe.

• Verify the Google Chrome extension version in chrome://extensions/.
• If necessary, install the Google Chrome extension using the links in the table below.

Google Chrome re-verification: Google Chrome requires re-verification of permissions when the
Automation Anywhere Google Chrome extension is updated. If prompted, click Enable this item in the
Google Chrome message. Alternatively, re-enable the extension through the links in the table above.
Similarly, if you are deploying your Bot Runner from a master image, accept the permission from within
that image.

Средство записи пакет
version

Browser agent Google Chrome extension and
ID

2.0.5 or earlier Automation.BrowserAgent.exeVersion 11 or 12

ID:
jjpdebaihkangkfpbgefmnnlafkahebn

2.0.6 or later Automation.Bot.BrowserAgent.exeVersion 1.1.0.1 or later

ID:
kammdlphdfejlopponbapgpbgakimokm

Прим.:  If you upgrade the Bot Agent version by uninstalling the Bot Agent instead of directly upgrading,
this also uninstalls the Google Chrome extension. In that case, you must manually reinstall the Google
Chrome extension.

If you encounter an error when recording or running a бот that automates tasks in a Google Chrome
browser and you have installed the Google Chrome, you must perform additional steps to configure your
system. См. раздел Google Chrome extension troubleshooting.
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Ссылки, связанные с данной
Google Chrome extension troubleshooting
If you encounter an error when recording or running a бот that automates tasks in a Google Chrome
browser and you have installed Google Chrome, you must perform additional steps to configure your
system.

Google Chrome extension troubleshooting
If you encounter an error when recording or running a бот that automates tasks in a Google Chrome
browser and you have installed Google Chrome, you must perform additional steps to configure your
system.

Предварительные условия

Ensure the Automation Anywhere Google Chrome extension you are using corresponds with the Средство
записи пакет version in your боты. See Google Chrome browser extension requirements.
To configure your system to run the Google Chrome extension, choose the scenario that applies to you and
follow the steps.

Средство записи пакет version 2.0.9 or later:

1. Verify that Google Chrome extension version 1.1.0.1 or higher is installed and enabled.
To install the extension, see Version 1.1.0.1 or later.

2. Open the Windows registry to the Google Chrome browser agent: Computer
\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Google\Chrome\NativeMessagingHosts
\automation.bot.browseragent

3. Verify that the registry entry points to the Automation 360 Bot Agent installation directory:
C:\Program Files\Automation Anywhere\Bot Agent\AABrowserAgent
\AAChromeAgentManifest.json

If this configuration is missing, reinstall the Bot Agent.

Средство записи пакет version 2.0.6, 2.0.7, or 2.0.8 (for Version A2019.16 or
earlier)

1. Open the Windows registry to the Google Chrome browser agent: Computer
\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Google\Chrome\NativeMessagingHosts
\automation.chrome.agent
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2. Verify that the registry entry points to the Automation 360 global cache: C:\ProgramData
\AutomationAnywhere\GlobalCache\embedded-resources\<Recorder package
 version>\AAChromeAgentManifest.json

For example, C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-
resources\2.0.6-20200626-193519-1bd6fceb-b036-4202-9932-4dc18349bd5c
\AAChromeAgentManifest.json

If this configuration is missing, do the following steps as an admin:
a. Open the Automation 360 global cache: C:\ProgramData\AutomationAnywhere

\GlobalCache\embedded-resources\<Recorder package version>

b. Run the install.ps1 file.
c. Repeat steps 2 and 3 to verify the registry entry is updated.

Средство записи пакет version 2.0.5 or earlier, and never installed
Automation Anywhere Enterprise Version 11.3 or later

Прим.:  Use latest Средство записи пакет version available in your Control Room.

1. Verify that Google Chrome extension version 11 or 12 is installed and enabled.
To install the extension, see Version 11 or 12.

2. Open the Windows registry to the Google Chrome browser agent:
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Google\Chrome
\NativeMessagingHosts\automation.chrome.agent

3. Verify that the registry entry points to the Automation 360 global cache: C:\ProgramData
\AutomationAnywhere\GlobalCache\embedded-resources\<Recorder package
 version>\AAChromeAgentManifest.json

For example, C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-
resources\2.0.5-20200626-193519-1bd6fceb-b036-4202-9932-4dc18349bd5c
\AAChromeAgentManifest.json

If this configuration is missing, do the following steps as an admin:
a. Open the Automation 360 global cache: C:\ProgramData\AutomationAnywhere

\GlobalCache\embedded-resources\<Recorder package version>

b. Run the install.ps1 file.
c. Repeat steps 2 and 3 to verify the registry entry is updated.

4. Verify that the browser agent Automation.BrowserAgent.exe is running with the Google Chrome
extension installed and enabled.
If this configuration is missing, restart Google Chrome. Either disable and enable the Google Chrome
extension, or close all Google Chrome browser tabs and reopen a new window.
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Средство записи пакет version 2.0.5 or earlier, and installed Automation
Anywhere Enterprise Version 11.3 or later

1. Verify that Google Chrome extension version 11 or 12 is installed and enabled.
To install the extension, see Version 11 or 12.

2. Open the Windows registry to the Google Chrome browser agent: Computer\HKEY_CURRENT_USER
\Software\Google\Chrome\NativeMessagingHosts\automation.chrome.agent

• If the above key is available, disable the Google Chrome plug-in version 11.x and enable the
Google Chrome plug-in version 12.x.

• If the above key is not available, disable the Google Chrome plug-in version 12.x and enable the
Google Chrome plug-in version 11.x.

3. Restart Google Chrome. Either disable and enable the Google Chrome extension, or close all Google
Chrome browser tabs and reopen a new window.

4. Verify that the browser agent Automation.BrowserAgent.exe is running with the Google Chrome
extension installed and enabled.

Automation Anywhere Enterprise Version 11.3 or later is uninstalled

Uninstalling the Enterprise Client does not remove the Google Chrome extension and registry entries. To
remove them manually, do these steps:
1. Disable Google Chrome extension 12.x.
2. Install and enable Google Chrome extension 11.x.
3. In the Windows registry editor, remove the following key: Computer\HKEY_CURRENT_USER

\Software\Google\Chrome\NativeMessagingHosts\automation.chrome.agent

4. Open the Windows registry to the Google Chrome browser agent:
Computer\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Google\Chrome
\NativeMessagingHosts\automation.chrome.agent

5. Verify that the registry entry points to the Automation 360 global cache: C:\ProgramData
\AutomationAnywhere\GlobalCache\embedded-resources\<Recorder package
 version>\AAChromeAgentManifest.json

For example, C:\ProgramData\AutomationAnywhere\GlobalCache\embedded-
resources\2.0.6-20200626-193519-1bd6fceb-b036-4202-9932-4dc18349bd5c
\AAChromeAgentManifest.json

6. Restart Google Chrome. Either disable and enable the Google Chrome extension, or close all Google
Chrome browser tabs and reopen a new window.

Google Chrome extension installed in Microsoft Edge

Although Microsoft Edge browser settings allow extensions from the Chrome Web Store, we recommend
that you do not install the Google Chrome extension in the Microsoft Edge browser. Installing it causes
recording and runtime errors in боты that interact with the Google Chrome browser. Even if you did not
manually install the Google Chrome extension, the auto-sync settings in the Microsoft Edge browser might
have automatically installed the extension.
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Unable to view Google Chrome extension in offline mode

1. Drag the file ChromeExtension.crx to the Google Chrome extension tab.
This file is available in the same path where the Automation.BrowserAgent.exe file is available.
Enable the Automation 360 Google Chrome extension.

2. If the Google Chrome extension is still not visible:
a. Verify if the registry entry automation.chrome.agent is available in the path Computer

\HKEY_CURRENT_USER.
If it is not available, create the registry in the following path: Computer\HKEY_CURRENT_USER
\Software\Google\Chrome\NativeMessagingHosts\automation.chrome.agent

This entry should have the same path as the entry: Computer\HKEY_LOCAL_MACHINE
\Software\Google\Chrome\NativeMessagingHosts\automation.chrome.agent

b. Go to the path Computer\HKEY_LOCAL_MACHINE\Software\Google\Chrome
\Extensions.
For the 11.1.0.0 Automation 360 Google Chrome extension ID
jjpdebaihkangkfpbgefmnnlafkahebn, create a new string with the name path.
The value of the string will be the path of the ChromeExtension.crx, which is available in the
same folder where the AAChromeAgentManifest.json file is available.
For example, add the entry C:\ProgramData\AutomationAnywhere\GlobalCache
\embedded-resources\2.0.5-20200511-172840-1825fd43-19bc-4dd2-
ac56-53a2aed4b0e4\ChromeExtension.crx in the following locations:
• Computer\HKEY_LOCAL_MACHINE\Software\Google\Chrome

\Extensions(ExtensionID)
• Computer\HKEY_CURRENT_USER\Software\Google\Chrome

\Extensions(ExtensionID)

c. Restart Google Chrome. Either disable and enable the Google Chrome extension, or close all
Google Chrome browser tabs and reopen a new window.

Secure recording mode
Если включен режим безопасной записи, то боты не записывают значения определенных свойств
и не сохраняют образы приложений. This ensures that sensitive data is not stored in the боты. This
setting only applies to боты that are created or edited after the mode is enabled.
A user with admin privileges must enable secure recording mode. См. раздел Настройки.
To capture objects in secure recording mode, ensure that the Средство записи пакет is set to
2.0.0-20200318-020414 or higher. См. раздел Manage Control Room packages.
When you record a task in secure recording mode, the Preview window temporarily shows the captured
area. This image is deleted after you close the бот.
When you record a task in secure recording mode, you can choose whether or not the captured images are
available for preview and stored in the Control Room. См. Безопасная запись

Прим.:  Ensure that you use the latest version of the Средство записи пакет. If you are using the
2.7.3-20220527-004608 or an older version of the Средство записи пакет, a preview of the images will be
shown in the Bot editor when the objects are captured. The images will be discarded when you refresh the
Bot editor.
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You can update the following object properties after capturing an object:

Technology Object property

Microsoft Active Accessibility/UI automation/Java • Имя элемента
• Item value
• Имя
• Parent
• Значение

HTML • Внутренний текст HTML
• HTML name
• HTML value

Microsoft UI Automation (COM) • Описание
• Изображение
• Значение
• Имя
• Parent
• Имя элемента
• Item value
• Data provider
• Content
• Legacy name
• Legacy value
• Legacy description

Recording tasks in applications that run on JRE
Use the Universal Recorder to capture objects from Java applet, web start, and desktop applications that
run using Java Runtime Environment (JRE) 6, 7, 8, 9, 10, and 11.
Automation 360 supports JRE 6 and later on both 32-bit and 64-bit systems.
Verify whether additional configuration is necessary, depending on the JRE version:
• If JRE 7 update 6 or later is installed on the registered device, Java Access Bridge is automatically

installed on that device.
• If JRE 7 update 5 or earlier is installed on the registered device, you must manually copy the required

files to the corresponding directories. См. раздел Java Access Bridge.
• If you have more than one version of JRE, Automation 360 configures Java Access Bridge with the

default version. To configure it to a different version, you must manually copy the required files to the
corresponding directories. См. раздел Java Access Bridge.

The first time you record a task in an application running on JRE 6 or 7 update 5 or earlier, an error
message might appear if the application is launched before Java Access Bridge is installed. Restart the
application and proceed with recording the task.
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AISense для записи задач из удаленных приложений
AISense — это способность искусственного интеллекта (ИИ) в Automation 360, которая помогает
идентифицировать объекты на изображении или в приложении со сложным пользовательским
интерфейсом (UI), а также повысить скорость и точность автоматизации в любых средах.
AISense подходит, когда автоматизация на основе объектов не работает или неэффективна для
автоматизации задач в приложениях, доступ к которым осуществляется удаленно, в среде Citrix, а
также в устаревших приложениях.
Некоторые проблемы, влияющие на точность выполнения задачи автоматизации в удаленной среде:
• В среде Citrix платформа автоматизации получает образ приложения, но не имеет доступа к

фактическим элементам пользовательского интерфейса.
• Разрешение экрана и масштаб могут быть разными на хосте и клиентских компьютерах.
• Для веб-приложений положение элемента пользовательского интерфейса может измениться

из-за другого разрешения на компьютере Bot Runner.

AISense uses computer vision to intelligently create dynamic linking between objects by determining
their composition to deliver change-resilient automation. AISense enables you to accurately automate
applications even when labels and text change their position.

Важное замечание:
• Выполнение Боты завершается ошибкой, если они содержат actions из Средство записи пакет

версии 2.0.9-20201105-164103 или более поздней и пакет AISense. You must delete the AISense
actions and recapture the objects using the integrated recorder icon. An integrated Средство записи

• AISense Recorder поддерживает следующие языки: English, Simplified Chinese, Korean, Brazilian-
Portuguese, Japanese, and Russian. При записи приложения убедитесь, что региональные
настройки устройства соответствуют языку приложения, независимо от операционной системы
и раскладки клавиатуры. Если пользовательский интерфейс (UI) приложения представляет
собой сочетание английского и другого языка, задайте в устройстве региональные настройки
для другого языка. Например, если пользовательский интерфейс представляет собой сочетание
английского и русского языков, задайте в устройстве региональные настройки для русского
языка.

Прим.:  Даже если региональные настройки устройства заданы для языка, отличного от
английского, можно продолжать автоматизировать приложения с пользовательским интерфейсом
на английском языке, не переходя в устройстве на региональные настройки для английского
языка.

Recommendation:  On any application, regardless of the language of the application, when you use the
Get text action to retrieve text from a specified area, if the retrieved text is not accurate, we recommend
that you perform one of the following actions and then record again:
• Increase the font size.
• Decrease the screen resolution.
• Zoom in to capture the text correctly.

Задачи, связанные с данной
Record a task with AISense Recorder
Use the AISense Recorder to record an end-to-end task on a remote application or an application with a
complex user interface (UI).
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Edit a task recorded using AISense
After you have recorded a task using the AISense Recorder, you can edit the recorded actions to perform
various actions on the captured objects.

Record a task with AISense Recorder
Use the AISense Recorder to record an end-to-end task on a remote application or an application with a
complex user interface (UI).
• If you are automating a task using a browser, ensure that auto-fill is disabled for that browser.
• The screen resolution must be set to 1980x1080 or lower.
• Configure the device display settings to 100% DPI.
• If you are using Automation 360 On-Premises, ensure that the AISense Recorder пакет is added to

your Control Room.

AISense Recorder can capture the following objects from an application: text boxes, buttons, radio
buttons, combo boxes, check boxes, active and passive text, image button, scroll, and combo box.
Keep the following considerations in mind when recording a task:
• Record the task at low speed.
• Avoid dragging windows during the recording process.
• Avoid clicking applications that are not part of the process you are recording to automate.

To record a task using the AISense Recorder, follow these steps:
1. From Automation Anywhere web interface left panel, click Automation.
2. Create a new бот or open an existing бот for which you want to record a task.
3. Click Start recording.

Прим.:  In versions 2.0.9-20201105-164103 and later, the Средство записи пакет contains both the
Universal Recorder and AISense Recorder.
An integrated Средство записи

The Automation Anywhere Recorder window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click AISense Recorder.

The first time you use the AISense Recorder on a device, the Средство записи downloads the
required dependencies.
The Recorder toolbar appears with Finish, Scan, Define, and Pause options.
The Средство записи analyzes the application window you selected to identify the UI objects in that
window. The options on the toolbar are disabled when the system is analyzing the application window.
After the analysis, the options are enabled and you can start recording the task.

6. Perform the actions to record. For example, click buttons, fill in forms, or select an option.
To perform an action on an object, move the mouse pointer on that object. The system highlights
an object along with the text associated with that object. For example, when you move the mouse
pointer over a button or check box, the associated text with that button or check box is also
highlighted and captured.
• If the object is not highlighted, click the Scan option on the recording toolbar. After the system

finishes analyzing the application window, you can capture the required object.
• If you want to capture an option from a list, click the list and wait until the highlight appears

around the box containing the options. After the box is highlighted, move the mouse pointer over
the option you want to capture and wait until the option is highlighted.
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• If you use scroll on an application window, you must click Scan to analyze the new objects on the
window.

• If you want to record an interaction with an object that is only visible when you hover the mouse
over the object, see Detect hidden objects manually

The Recorder window contains the number of operations recorded and a description of the most
recently captured object. For example, 5. Left click on button 'Submit'.
To redo the previous object capture, click the Delete icon at the bottom right of the Recorder
window to discard the most recent capture.
If Secure recording mode is enabled, a shield icon appears to the right of the red recording icon.
Secure recording mode

7. Click Finish after you finish capturing all the necessary objects.
A Capture action is generated for each operation.
Where applicable, the Recorder generates variables. Your variables (user-defined)

8. Edit the actions or click Save.
Edit a task recorded using AISense

Detect hidden objects manually
If an object is only visible when you hover the mouse over the object, you must manually specify the
object type and location by anchoring it to the nearest text:
1. Click the object once.
2. Click Define.

The AISense Define main object window appears with a screenshot of the application, where the
object is visible.

3. Click and drag a rectangle to outline the object to capture.
4. In the Supporting anchor list, select the text that is closest to the object you are capturing.
5. Щелкните Применить.

Задачи, связанные с данной
Edit a task recorded using AISense
After you have recorded a task using the AISense Recorder, you can edit the recorded actions to perform
various actions on the captured objects.
Ссылки, связанные с данной
AISense для записи задач из удаленных приложений
AISense — это способность искусственного интеллекта (ИИ) в Automation 360, которая помогает
идентифицировать объекты на изображении или в приложении со сложным пользовательским
интерфейсом (UI), а также повысить скорость и точность автоматизации в любых средах.
Actions performed on objects captured with AISense Recorder
After you capture objects using the AISense Recorder, you can perform various actions that a бот can
perform on the object at runtime.

Edit a task recorded using AISense
After you have recorded a task using the AISense Recorder, you can edit the recorded actions to perform
various actions on the captured objects.
Edit a recorded task to do the following:
• Change the application window in which you want to perform the operation, or add a wildcard to the

window title.
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• Change the properties of the captured objects.
• Specify the action you want to perform on the captured objects.
• Introduce a delay before the next action is performed.
• Specify the variable you want to use to store the output.

Важное замечание:  Only the following types of objects are supported with AISense Recorder:
• Text boxes
• Check boxes
• Combo boxes
• Radio buttons
• Buttons
• Active text

Active text is the text that you can click. For example, link, menu, text on a navigation pane, and so on.
When there are duplicate active texts on the window, the AISense Recorder identifies and applies the
action of the first occurrence of that active text on the window.

• Passive text
Passive text is the text that you can only read. It can be any text visible on the window that can be
associated with a nearby static anchor text that is available during бот execution. When you select an
area that has multiple lines, the AISense Recorder retrieves only the first line of the text from the area.

• Image button
An image button is a button that contains only image and does not have any text associated with it. For
example, icons for delete, copy, cut, paste, and so on. You can capture image buttons that are hidden
on the application screen and appear when you hover the mouse pointer over them.

• Scroll on an application window and combo box

To edit a recorded task, perform the following steps:
1. Open the бот that contains the recorded actions you want to edit.
2. Click the Capture action that you want to edit.
Make the following changes, as necessary:
3. Click the Window tab or the Variable tab to specify a different application window on which you

want to perform the operation.
If you have used the Window tab to specify the application window, you can use a wildcard character
in the Window title field. The wildcard character is useful if the title of an application changes. For
example, Sample* - Google Chrome.

Прим.:
• During runtime, verify that the TaskBot identifies the correct window.
• If you use scroll on an application window, you must click the Analyze window option to analyze

the new objects on the window.

4. Update the object properties.
You can only update the value available in the Anchor field.

5. Select an option from the Action list to specify the action you want to perform on the object.
For a full list of possible actions by object, see Actions performed on objects captured with AISense
Recorder.
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6. Необязательно: Enter a value in the Wait for control field to specify the number of seconds the бот
must wait for the object control to appear on the application window.
We recommend setting a delay time when using the Set text action to enter keystrokes into a text
field.

7. Необязательно: Assign the output to a variable.
The Control Room suggests a descriptive default variable name based on the action that you selected
previously. For example, if you selected Get text, the suggested output variable is CaptureText.
If you create several output variables, subsequent variable names are suffixed with a hyphen and
number to prevent duplication of variable names.

8. Perform the Steps 2 through 7 for the other actions that you want to edit in the бот.
9. Щелкните Сохранить.

Link nearby text to a supporting anchor
At run time, if the бот cannot reliably identify an object, link the object to nearby text that is easier for the
бот to find:
1. Open the Capture action.
2. Click the Anchor tab.
3. Click Capture anchor.

The browser or application window activates with the main object highlighted (the object that you
previously captured). A dialog box appears, verifying whether the action has correctly identified the
main object.

4. If the correct object is highlighted, click Yes, Select anchor.
Otherwise, click No, I need to correct it to select the correct object.

5. Select nearby text to the target object that is easier for the бот to find.
The text is highlighted with an anchor icon to the right of the text.

6. Щелкните Сохранить.

Actions performed on objects captured with AISense Recorder
After you capture objects using the AISense Recorder, you can perform various actions that a бот can
perform on the object at runtime.
For example, when you capture a button, you can select to click the button or to retrieve the button text.
The following table lists the objects and their possible actions.

Объект Действия

Кнопка • Get text: Extracts the value or caption from the specified captured
object.

• Click: Use this action to select the captured object.
• Left click: Use this action if the Click action does not work during

runtime.
• Right click: Use this action to perform the right-click operation on the

captured object.
• Double click: Use this action to perform the double-click operation on

the captured object.
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Объект Действия

Image button • Left click: Use this action if the Click action does not work during
runtime.

• Right click: Use this action to perform the right-click operation on the
captured object.

• Double click: Use this action to perform the double-click operation on
the captured object.

Active text • Left click: Use this action if the Click action does not work during
runtime.

• Right click: Use this action to perform the right-click operation on the
captured object.

• Double click: Use this action to perform the double-click operation on
the captured object.

Passive text Get text: Retrieves text available in the area you have specified.

Флажок • Get text: Extracts the value or caption from the specified captured
object.

• Get status: Retrieves whether the check box is selected. Returns
checked or unchecked.

• Check: Selects the captured check box.
• Uncheck: Clears the captured check box.
• Toggle: Sswitches the check box to the opposite status. For example,

if the check box is selected, use the Toggle action to clear it.
• Left click: Use this action if the Toggle action does not work during

Runtime.
• Right click: Use this action to perform the right-click operation on the

captured object.
• Double click: Use this action to perform the double-click operation on

the captured object.

Combo box (appears as
a drop-down list)

• Get text: Extracts the value or caption from the specified captured
object.

• Get selected text: Retrieves text from the selected item.
• Select item by text: Selects the item that matches the text you have

specified in the Assign value field.

Прим.:  The Assign value field is case-sensitive.

• Expand: Expands the combo box.
• Click: Use this action to select the captured object.
• Left click: Use this action if the Click action does not work during

runtime.
• Right click: Use this action to perform the right-click operation on the

captured object.
• Double click: Use this action to perform the double-click operation on

the captured object.
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Объект Действия

Scroll bar (within a
combo box)

• Scroll Up: Performs the scroll up operation. This action is similar to
clicking the scroll up button one time.

• Scroll Down: Performs the scroll down operation. This action is
similar to clicking the scroll down button one time.

• Page Up: Performs the page up operation. This action is similar to
holding the scroll bar and moving it up. The distance by which the
scroll bar is moved up is specified in the Scroll Distance field.

• Page Down: Performs the page down operation. This action is similar
to holding the scroll bar and moving it down. The distance by which
the scroll bar is moved down is specified in the Scroll Distance field.

• Left click: Use this action if the Click action does not work during
runtime.

• Right click: Use this action to perform the right-click operation on the
captured object.

• Double click: Use this action to perform the double-click operation on
the captured object.

RadioButton • Get text: Extracts the value or caption from the specified captured
object.

• Get status: Retrieves whether the radio button is selected. Returns
selected or deselected.

• Select: Use this action to select the captured radio button.
• Left click: Use this action if the Click action does not work during

runtime.
• Right click: Use this action to perform the right-click operation on the

captured object.
• Double click: Use this action to perform the double-click operation on

the captured object.

Текстовое поле • Get text: Extracts the value or caption from the specified captured
object.

• Set text: Enters the text you have specified in the captured field. It
supports credentials.
Credentials and credential variables in the Bot editor

• Append text: Adds text at the end of existing text in the captured
field, instead of overwriting it.

• Click: Use this action to select the captured object.
• Left click: Use this action if the Click action does not work during

runtime.
• Right click: Use this action to perform the right-click operation on the

captured object.
• Double click: Use this action to perform the double-click operation on

the captured object.

Capture Image button through AISense Recorder
Image buttons or icons are clickable buttons with no anchors. An application can have one or multiple
image buttons. AISense Recorder uses template matching to detect and match image buttons on an
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application. So even after you record, if the position of the image button changes due to window resizing,
AISense Recorder can detect the object and run the бот.

Capture Image button

1. На левой панели щелкните Автоматизация.
2. To create a бот, click Create new > Bot, or open a бот for which you want to record a task.
3. Click Start recording.

The Средство записи бот runtime window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click AISense Recorder and allow the scanning process to finish.

Прим.:  The AISense Recorder downloads the required dependent files the first time you use it on a
device.

The AISense Recorder toolbar appears with these options: Finish, Scan, Define, and Pause.
The AISense Recorder analyzes the selected application window to identify the UI objects in that
window. When the system is analyzing the application window, the options on the toolbar are
unavailable. After the analysis completes, the options are enabled and you can start recording the
task.

6. Wait for the AISense Recorder to detect the object.
7. If the object is not detected automatically, then when the AISense Recorder reaches the Ready state,

you can click the Define button to detect the object.

Прим.:
• In the Define window, the  shows embedded help for each control type so you can select the

correct control types for custom objects.
• If you unintentionally click the screen or click before the highlighter appears,  provides visibility

into it. You must confirm to capture the object again, or use the Define functionality to define the
object on the screen.

.
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8. Select Image button from the Select the object type for the selected area tab.

9. Draw a rectangle around the image button that you want to capture.
The selected area is shown in the box below the Drag and select the area which you want to
define from the image field.

10. Hover the mouse cursor over the nearby static text. Once the text is highlighted, select the static text
as the supporting anchor.
The image of the anchor is shown in the box below the Select one supporting anchor point for
the selected area field.

11. Click Define.
12. After you have captured the required objects, click Finish.

Capture link button through AISense Recorder
The link button control is clickable and has no specific features. In some cases, the AISense Recorder
cannot detect it. You must use the Define option to detect and capture the link button control.
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Capture link button

1. На левой панели щелкните Автоматизация.
2. To create a бот, click Create new > Bot, or open a бот for which you want to record a task.
3. Click Start recording.

The Средство записи бот runtime window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click AISense Recorder and allow the scanning process to finish.

Прим.:  The AISense Recorder downloads the required dependent files the first time you use it on a
device.

The AISense Recorder toolbar appears with these options: Finish, Scan, Define, and Pause.
The AISense Recorder analyzes the selected application window to identify the UI objects in that
window. When the system is analyzing the application window, the options on the toolbar are
unavailable. After the analysis completes, the options are enabled and you can start recording the
task.

6. Wait for the AISense Recorder to detect the object.
7. If the object is not detected automatically, then when the AISense Recorder reaches the Ready state,

you can click the Define button to detect the object.

Прим.:
• In the Define window, the  shows embedded help for each control type so you can select the

correct control types for custom objects.
• If you unintentionally click the screen or click before the highlighter appears,  provides visibility

into it. You must confirm to capture the object again, or use the Define functionality to define the
object on the screen.

.
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8. Select Link from the Select the object type for the selected area tab.

9. Draw a rectangle around the link button that you want to capture.
The selected area is shown in the box below the Drag and select the area which you want to
define from the image field.

10. Hover the mouse cursor over the text. Once the text is highlighted, select the link text as the
supporting anchor.
The image of the anchor is shown in the box below the Select one supporting anchor point for
the selected area field.

11. Click Define.
12. After you have captured the required objects, click Finish.

Capture text value through AISense Recorder
Passive texts are texts that are readable only. To make decisions, боты might require extracting texts,
for example, key-value pair or text value from a form. If the AISense Recorder cannot detect the texts
automatically, then you must use the Define option to detect the texts.
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Capture the text value

1. На левой панели щелкните Автоматизация.
2. To create a бот, click Create new > Bot or open a бот for which you want to record a task.
3. Click Start recording.

The Средство записи бот runtime window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click AISense Recorder and allow the scanning process to finish.

Прим.:  The AISense Recorder downloads the required dependent files the first time you use it on a
device.

The AISense Recorder toolbar appears with these options: Finish, Scan, Define, and Pause.
The AISense Recorder analyzes the selected application window to identify the UI objects in that
window. When the system is analyzing the application window, the options on the toolbar are
unavailable. After the analysis completes, the options are enabled and you can start recording the
task.

6. Wait for the AISense Recorder to detect the object.
7. If the object is not detected automatically, then when the AISense Recorder reaches the Ready state,

you can click the Define button to detect the object.

Прим.:
• In the Define window, the  shows embedded help for each control type so you can select the

correct control types for custom objects.
• If you unintentionally click the screen or click before the highlighter appears,  provides visibility

into it. You must confirm to capture the object again, or use the Define functionality to define the
object on the screen.

.

8. Select Text value from the Select the object type for the selected area tab.
9. Draw a rectangle around the text area that you want to extract.

The selected area is shown in the box below the Drag and select the area which you want to
define from the image field.

10. Hover the mouse cursor over the nearby static text. Once the text is highlighted, select the static text
as the supporting anchor.
The image of the anchor is shown in the box below the Select one supporting anchor point for
the selected area field.

11. Click Define.
12. After you have captured the required objects, click Finish.
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Known behavior

AISense Recorder cannot extract texts with multiple lines. If you select multiple lines, only the first line is
extracted.

Capture Textbox, Radio, Checkbox, and Combobox
When a screen is dense, sometimes the AISense Recorder cannot detect and classify the controls correctly.
To continue to automate the controls seamlessly, you can use the AISense Recorder to capture coordinates
of controls and perform certain actions without having to use the Мышь and Имитация нажатия клавиш
пакеты separately.

Textbox, Radio, Checkbox, and Combobox

Прим.:  Any textbox, radio, checkbox, and combobox controls captured using Define functionality will be
coordinate based automation. This functionality is provided for continuity of workflow.

1. На левой панели щелкните Автоматизация.
2. To create a бот, click Create new > Bot or open a бот for which you want to record a task.
3. Click Start recording.

The Средство записи бот runtime window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click AISense Recorder and allow the scanning process to finish.

Прим.:  The AISense Recorder downloads the required dependent files the first time you use it on a
device.

The AISense Recorder toolbar appears with these options: Finish, Scan, Define, and Pause.
The AISense Recorder analyzes the selected application window to identify the UI objects in that
window. When the system is analyzing the application window, the options on the toolbar are
unavailable. After the analysis completes, the options are enabled and you can start recording the
task.

6. Wait for the AISense Recorder to detect the object.
7. If the object is not detected automatically, then when the AISense Recorder reaches the Ready state,

you can click the Define button to detect the object.

Прим.:
• In the Define window, the  shows embedded help for each control type so you can select the

correct control types for custom objects.
• If you unintentionally click the screen or click before the highlighter appears,  provides visibility

into it. You must confirm to capture the object again, or use the Define functionality to define the
object on the screen.

.

8. Select the specific object type from the list of object types from the Select the object type for the
selected area tab.
The object types that you select is shown under Current selection.
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9. Draw a rectangle around the control that you want to capture.
The selected area is shown in the box below the Drag and select the area which you want to
define from the image field.

10. Hover the mouse cursor over the text. Once the text is highlighted, select and define the text as the
supporting anchor for identification.
The image of the anchor is shown in the box below the Select one supporting anchor point for
the selected area field.

11. Click Define.
12. After you have captured the required objects, click Finish.

Table data extraction through AISense Recorder
Tables are a complex control, with many types, backgrounds, and formatting effects, and hence might not
be automatically detected by AISense Recorder in some cases. In such cases, use the Define option to
detect tables.

Capture a table using AISense Recorder

1. На левой панели щелкните Автоматизация.
2. To create a бот, click Create new > Bot or open a бот for which you want to record a task.
3. Click Start recording.

The Средство записи бот runtime window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click AISense Recorder. Let the scanning process finish.

Прим.:  The first time you use AISense Recorder on a device, the Средство записи downloads the
required dependent files.

The Средство записи toolbar appears with the following options: Finish, Scan, Define, and Pause
The Средство записи analyzes the application window that you selected to identify the UI objects in
that window. The options on the toolbar are unavailable when the system is analyzing the application
window. After the analysis, the options are enabled and you can start recording the task.

6. Wait for AISense Recorder to detect the table in the application.
7. If the table is not detected automatically, then when AISense Recorder is in the Ready state, click the

Define button to detect the table.

Прим.:
• In the Define window, the  shows embedded help for each control type so you can select the

correct control types for custom objects.
• If you unintentionally click the screen or click before the highlighter appears,  provides visibility

into it. You must confirm to capture the object again, or use the Define functionality to define the
object on the screen.

.

8. Select Table from the Object type tab and click the top-left header.
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The detected table will be highlighted with columns and internal controls.
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9. If you want to select a limited set of columns, then draw a rectangle around the columns that you
want to capture.

Extract data from a table

1. After the object is captured, click Finish to end the recording.
2. Return to the Control Room.
3. In the Object properties table, verify that the Control Type is TABLE. If it is not, click Recapture

object.
4. From the Action to take on object drop-down list, select Get table.
5. In the Save the outcome to a variable field, create the CapturedTableData variable.
6. Double-click or drag the Data Table > Write to file action.
7. From the Data table name list, select CapturedTableData.
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8. Provide a filepath to create a CSV file. For example, C:\AutomationAnywhere\Development
\SFDC.csv

9. Select the Create folders/files if it doesn't exist option.
10. Select to overwrite the existing file.
11. Щелкните Сохранить.
12. Click Run.

The бот creates a CSV file in the specified path with the table data extracted.

Correct a column definition

It is possible that dense tables can merge columns due to less space between columns or lack of clear
separators. To correct the column definition, perform the following steps:
1. After the object is captured, click Finish to end the recording.
2. On the Bot editor window, go to Object properties to edit the Anchor Table property.
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3. Add the pipe character (|) as a delimiter between the column names to separate them. For example,
<CHECKBOX>Name|Company|State|Email|Lead status

Прим.:  When the бот is run, previously merged columns will be treated as separate columns.

Known behavior

• AISense Recorder cannot extract tables with multiple lines in single rows or cells.
• Pagination and autoscrolling are not supported.
• Truncated columns will not be automatically adjusted to extract truncated cell text.
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Use variable anchor
You can use the variable anchor to automate same controls that have different anchors. For example,
pages having multiple checkboxes with different captions. These captions might be dynamic and might
change based on the workflow. You can use the variable anchor to capture the control once, and then
use the anchor as a variable in the Bot editor window. You can use a variable from various sources, for
example, Microsoft Excel, CSV, or database.

Capture using variable anchor

1. На левой панели щелкните Автоматизация.
2. To create a бот, click Create new > Bot or open a бот for which you want to record a task.
3. Click Start recording.

The Средство записи бот runtime window appears.
4. Select a window from the drop-down list.

If you opened an application recently and it is not available in the list, click the Refresh icon.
5. Click AISense Recorder and allow the scanning process to finish.

Прим.:  The AISense Recorder downloads the required dependent files the first time you use it on a
device.

The AISense Recorder toolbar appears with these options: Finish, Scan, Define, and Pause.
The AISense Recorder analyzes the selected application window to identify the UI objects in that
window. When the system is analyzing the application window, the options on the toolbar are
unavailable. After the analysis completes, the options are enabled and you can start recording the
task.

6. Wait for the AISense Recorder to detect the object.
7. If the object is not detected automatically, then when the AISense Recorder reaches the Ready state,

you can click the Define button to detect the object.

Прим.:
• In the Define window, the  shows embedded help for each control type so you can select the

correct control types for custom objects.
• If you unintentionally click the screen or click before the highlighter appears,  provides visibility

into it. You must confirm to capture the object again, or use the Define functionality to define the
object on the screen.

.
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8. Select Variable anchor from the Select the object type for the selected area tab.

9. Draw a rectangle around the checkbox that you want to capture.
The selected area is shown in the box below the Drag and select the area which you want to
define from the image field.

Прим.:  Hover the mouse over the checkbox and ensure that the checkbox is detected and
highlighted with red rectangle before you click Define.

10. Hover the mouse over the closest static text. Once the text is highlighted, select the text as the
supporting anchor.
The image of the anchor is shown in the box below the Select one supporting anchor point for
the selected area field.

11. Click Define.
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12. After you have captured the required objects, click Finish.
The recorded steps appear as a separate action in the бот.
For each variable anchor action, you can copy the added action and update the value in the Anchor
field with the anchor text of the object you want to capture, for each variable anchor action.
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Alternatively, you can use the action within the Цикл action and use a variable that supports the String
data type in the Anchor field.
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Прим.:
• You can assign only highlighted controls to a variable.
• Ensure no additional control or text exists between the anchor and the control.

Enable debug logs for AISense Recorder
You can use debug logs to troubleshoot the application window that you capture and to verify if the object
is being detected correctly. The results are available as debug images in the %temp%\AISenseLogs
folder.
1. On your local device, browse to C:\Program Files\Automation Anywhere\Bot Agent

\config.
2. Open the botlauncher-logging.xml file.
3. Include the following logger entry within the <Loggers> XML element and save the XML file:

<Logger name="com.automationanywhere.recorder" level="DEBUG"/>
For example, add the debug logger entry below the existing logger entry.

<Logger name="com.automationanywhere.recorder" level="INFO"/>
<Logger name="com.automationanywhere.recorder" level="DEBUG"/>

Changes you make to the logging configuration file are updated in seconds configured per the monitor
interval value.

Прим.:  If the changes are not automatically applied per the monitor interval value, restart the Bot
Agent service.

AISense Recorder best practices
To use the AISense Recorder optimally, review the best practices.

Configuring registered devices

• Ensure you use only recommended hardware configuration for registered device as specified. См.
Automation 360 Bot Runner device requirements

• If application is running on same device, we recommend you to add additional CPU or RAM to avoid
slowness. См. Automation 360 Bot Runner device requirements

• If you are automating a task using a browser, ensure that auto-fill is disabled for that browser.
• Ensure that the screen resolution is set to 1980x1080 or lower. См. Record a task with AISense Recorder
• Configure the device display settings to 100% DPI. См. Record a task with AISense Recorder

Behavior

• When you use the AISense Recorder for the first time on any device, either for recording or for
playback, it downloads the required resources from the Control Room. This process might take a few
or several minutes depending on the speed of your internet. The state of the process is indicated in
the progress bar during recording and the Bot runtime window shows Downloading additional
resources.

• When you use a new пакет in a бот and if the пакет has any updated resources, it gets downloaded
automatically that results in a delay in бот execution.

• There is a delay in scanning or bot execution in the following cases:
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• The first execution will setup AISense environment which will take couple of seconds (based on
machine configuration). User will observe some delay in scanning and бот execution.

• Every time application changes, due to navigation or new controls loaded, AISense has to detect
new available controls on the application screen, which will take couple of seconds (based on
machine configuration). User will observe some delay in scanning and бот execution.

• Parent and child бот execution: If child бот is using AISense Recorder, every time the child бот
is executed, an AISense environment gets created to maintain isolation between боты. User will
observe some delay in бот execution.

Methodology

• Record the task at low speed. Click only after the red highlighter appears around the object.
• Avoid dragging the windows during the recording process.
• If AISense Recorder is downloading required resources from the Control Room in case it is deployed for

the first time, do not close the Средство записи window in between since doing so might corrupt the
required resource files.

• When the AISense Recorder is in Scanning state, avoid switching between applications.
• When the AISense Recorder is in Ready state, move the mouse slowly over the object or control that

you want to capture and make sure that it gets highlighted with the red rectangle and then click on it.

Capturing Combo box

The following are some best practises that you can follow when you use the AISense Recorder to capture
combo boxes. Below are some of the combo boxes based on the application requirements.
• Searchable combo box: The searchable combo box enables you to click in the text area and type.

It then starts filtering the typed text from the list and allows you to press enter when a single result is
available.
• To automate this combo box control, during recording, highlight the combo box and click in the

center of the combo box. The default action selected will be Select Item by Text. Finish the
recording.

• Go back to control room bot editor. Enter the text value along with Enter or combination of
Down (down arrow) and Enter to simulate user like action. For example, if you are automating a
searchable combo box which has a dropdown list item, then you can either enter the value in the
searchable combo box and click Enter to select it or use the down arrow to search for the specific
value and click Enter to select that value from the list.
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• Legacy combo box: The legacy combo box does not have a search functionality and it is mandatory
to expand it by clicking triangular button on right side of combo box and select one of the value.
• To automate this combo box control, during recording, highlight the combo box, it should also

highlight the small triangular button on right side.

Прим.:  Ensure that it also highlights the small triangular button on the right side.

• Click the button and wait.
The Средство записи must take sometime to identify expanded value. During this time, the
recording icon in the Средство записи window must be in the blinking state.

• As soon as the small recording icon stops blinking, hover the mouse over the list box (expanded
combo box) and make sure it highlights list values.

• Select the specific values.
• User can select any value and and later change it from the Bot editor window in the Automation

Anywhere Control Room.

Using AISense Recorder with other Packages

AISense Recorder is computer vision based object detection method of automating where it captures
the image of the application that you want to automate. When you use AISense Recorder to automate
applications that have objects like textbox with single underline or combobox without triangular button, the
objects might not get detected. In such cases, we recommend you use a combination of AISense Recorder
with other packages like Распознавание текста (OCR) and Распознавание изображений пакеты or only
Распознавание текста (OCR) and Распознавание изображений пакеты to automate such use cases.

Client Control

AISense Recorder detects object on the application with specific feature set. When you click an area where
there is no control, or click a control before it highlights with red boundaries, it will be recorded as CLIENT
control. The client control is coordinate based capture of mouse click to replicate user click and is not
standard AISense control. We recommend user to recapture control if captured as CLIENT control.

Working with боты
Depending on the license and permission assigned to you, you can perform various бот operations and
access the private and public workspaces in the Control Room.

Лицензии

Two types of licenses are available: Bot Creator and Bot Runner (attended or unattended) licenses.

Лицензии Automation 360

Bot Creator tasks

A Bot Creator user can access both the private workspace and public workspace in the Control Room
by navigating to Automation on the left panel. The license provides the user exclusive access to the
registered device. Other users cannot use the default device of a Bot Creator.
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With the Bot Creator license and specific permissions, you can perform the following tasks:
• Create a bot
• Run a бот
• Record a bot

Record a task with the Universal Recorder|Record a task with AISense Recorder
• Планирование бот
• Copy a бот
• Assign label to a bot
• View bot version history
• Export a bot
• Import a bot
• Check in a бот
• Check out a single бот
• Delete a bot

You can also edit, analyze, save, clone, view content, pause, or stop a TaskBot.

Bot Runner tasks

A Bot Runner can access only to the public workspace in the Control Room. They cannot create or edit
боты.
With the Bot Runner license and specific permissions, you can perform the following tasks:
• Run a бот
• Планирование бот
• Assign label to a bot

You can also view the content of a TaskBot.

Public and private workspaces

The Automation page lists all the folders and боты available within the selected folder in the Public and
Private repositories. If you have migrated the Enterprise 11 or Enterprise 10 data to Automation 360, the
Automation page additionally displays the Enterprise 11 or Enterprise 10 TaskBots (.atmx) and MetaBots
(.mbot) files in the public repository.
When an Enterprise 11 or Enterprise 10 бот is migrated and converted to the Automation 360 бот, the
My Tasks and the My Metabots folders display the migrated (Enterprise 11 or Enterprise 10) and the
converted боты with the same name but different extension. This might create confusion to differentiate
between the two боты. Also, you cannot take any actions on the migrated боты except deleting them. To
avoid this confusion, you can use the Show menu option to show or hide the Enterprise 11 or Enterprise
10 боты.
The Show menu displays three options - Folder, .ATMX Task Bot, and .MBOT Meta Bot. By default,
each of these options are selected and displays all the folders and sub folders along with the Enterprise 11
or Enterprise 10 бот files.
If you clear the selected Folder option, then the sub-folders will be hidden from the files and folders list
and will only display .atmx or .mbot files and when you clear the selected. .ATMX Task Bot or the
.MBOT Meta Bot options, the .atmx or .mbot files, will then be hidden across all the folders.
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Depending on the license, users logging in to the Control Room can access the private and public
workspaces.

Private workspace Users with the Bot Creator license can access the
private workspace. This workspace is primarily
used to create and test боты. It enables users to
view and manage all their activities in one primary
location. Боты in the private workspace is available
only to the users who created them.

Прим.:
• Users with administrative privileges and Bot

Runner license cannot access the private
workspace because they cannot create боты.

• Имя бот должно быть уникальным. If a бот
or a folder with the same name exists in the
same folder location which you have access to in
the public workspace, you cannot either create,
check out, or rename the бот with this name in
the private workspace.

Public workspace Both Bot Creator and Bot Runner users can access
the public workspace. This is a shared workspace
where you can execute the боты.
Users with the Bot Runner license can run боты
created by the Bot Creator user. Боты created in
the private workspace by Bot Creator can be made
available to specific Bot Runner users in the public
workspace by defining the permissions at the folder
or file level. To do this, users have to first check in
the бот from the private workspace to the public
workspace.

Прим.:
• When you create a TaskBot with dependencies, ensure that both the parent and child бот are in the

same workspace (public or private). You cannot call a public бот from a private бот. To call a bot from
the public workspace, you should first check-out or clone the public бот into the private workspace,
include it as a child бот inside the private бот, and check-in both the боты.

• Folder names in private and public workspaces are case-sensitive. You can create a folder with the
same name and matching case in private and public workspaces. However, you cannot create folders
with the same name but with different case in the workspaces. For example, you can create a folder
My Metabots in both private and public workspace. However, you cannot create folder names that
use the same name but with different case, such as My Metabots in the private workspace and My
MetaBots in the public workspace.

• Sorting and filtering are supported for substrings. For example, if you want to search for боты or files
that have fin in the file or бот name, enter fin as the search criterion. All the боты and files that
contain fin in the names will be displayed, for example, Finance, Finder, DeltaFinance, and Dolfin.
Wildcards are not supported for searching and filtering боты or files.
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Run a бот
You can run a бот to test an automated process.
1. Войдите в Control Room.
2. On the left pane in the public workspace, click Automation.

Отобразится список доступных боты и форм.
3. Select the бот to run. Hover over the actions menu (vertical ellipses) located to the right of the бот

name and click Run Task Bot.
If an optional Bot Agent update for your device is available, the following message that Bot Agent has
an update is displayed one time per user session or when you log out and log in to the Control Room.

• To download and update the Bot Agent to the latest version on your device, use the Click here
link.

• To opt out of the update and continue with the existing Bot Agent version on your device, click
Continue without update.

4. Select the version of the бот to run.
• Последняя версия. To select the latest version of the бот, click the Latest version tab.
• Версия с меткой. To select the labeled version of the бот, click the Production version tab.

By default, the latest version of the бот is selected. Если для родительского бот выбран вариант
«Метка производства», то автоматически выбираются также соответствующие зависимые боты
с меткой производства. Если какие-либо из зависимых боты не имеют метки производства,
выбирается последняя версия бот.

5. Click the right arrow (→) to add your selection.
6. Select the Bot Runner users from the list of Available bot runners in the Run as tab.

The list of Bot Runner users that you have access to are displayed.
7. Click the right arrow (→) to add your selection.
8. Select the pool from the list of Available device pools in the Device pools tab.

The list of device pools for which you have a consumer role are displayed. Select the device pool only
if any of the selected Bot Runner users do not have a бот running (default) device.

9. Click the right arrow (→) to add your selection.
10. Необязательно: Выберите Приоритет автоматизации на вкладке Общие.

Установите высокий, средний или низкий приоритет в соответствии с вашими требованиями к
оптимизации ресурсов. По умолчанию для разрешения установлено значение «средний».
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11. Click Run bot now.

Прим.:  If you have not set the device credentials from the My settings page, you are prompted to
provide the device credentials to run the бот.

If you encounter issues in running a бот, refer to the following articles:
• Automation 360 - Unable to download the bot or the dependencies to the device; Error code: download.error (A-

People login required).
• There is already an existing deployment in-progress for this user session (A-People login required).
• BOT stuck in In Progress Stage and not able to move it to history" or "BOT stuck in Pending execution Stage and

not able to move it to history" on Automation 360 CLOUD and On-Prem environments

Considerations for running a бот
There are certain considerations you have to keep in mind when running a бот.
• As a Bot Creator, you can deploy a бот on your device or you can run the бот on a remote machine

through RDP connection.
• If you are running боты on your local machine as a Bot Creator, enter only your username in the device

login credentials; no password is required. The username is required to confirm that the same user
who logged in to the local device is deploying the бот. If you are using the Google Chrome plug-in and
running боты on your local machine, your username is required.

• As a Bot Runner, you can either deploy the бот yourself or select a run-as user assigned by the
administrator. You can run the бот either through your device or choose from the list of devices in a
device pool. If you choose to override the default device, the бот will be executed on any available
device in the device pool for each run-as user.

• You can preload packages on your local device to shorten the бот runtime.
The system supports running only one бот for each device at a given time. If a бот is already running
on the device, you cannot deploy another бот on the device.
While a бот is running on a device, if you try to deploy another бот on the same device, the second
бот is queued according to its type. After the deployment of the currently running бот is complete, the
queued бот is automatically deployed on the same device.

• If you are running a бот from the Bot editor, closing the Control Room web browser will stop the бот
run.

• Run-as user: A set of unattended Bot Runner users that a scheduler can select from to run a бот on a
device. The run-as user can select an available device from the device pool to run the бот.

• When боты are queued for a Bot Runner user, боты with higher priority are deployed before боты with
lower priority. However, if a бот with lower priority is already running, боты with higher priority are
deployed after the бот with lower priority completes running.

• When you create the бот deployment using the Run bot now option, the бот is queued for execution.
If the бот is deleted while it is queued for execution or while it is active, an error is displayed for that
бот in the In progress activity > View activity page.

• Attended Bot Runner, Bot Creator, and Непрофессиональный разработчик users can run the боты
using either the Run bot now option in the Bot editor or the shortcut key F5. However, unattended
Bot Runner users can run their bots only using the Run bot now option.

The following table explains the different scenarios where you should choose device pools against bot
running devices for the run-as user.
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Вариант Scenario Группа
устройств

Default device Результат

Information security
compliance where the
user cannot log in to any
other device

Нет Да Бот deploys on the default
device of the user.

Run бот now

Specialized application
access restricted to a
user

Нет Да Бот deploys on the default
device of the user.

Override bot running
device option is
selected

Да Да Бот deploys on the available
device in the device pool.

Override bot running
device option is not
selected

Да Да Бот deploys on the default
device of the user. If default
device is not available, the
бот deploys on the available
device in the device pool.

Information security
compliance where the
user cannot log in to any
other device

Нет Да Бот deploys on the default
device of the user.

Schedule бот

Specialized application
access restricted to a
user

Нет Да Бот deploys on the default
device of the user.

Run on bot running
devices option is
selected

Да Да Бот deploys on the default
device of the user.

WLM (Run бот
with queue)

Run on bot running
devices option is not
selected

Да Да Бот deploys on the default
device of the user. If default
device is not available, the
бот deploys on the available
device in the device pool.

AARI on the
web

Run-as user with device
pool assigned

Да Нет Бот deploys on the available
device in the device pool.

Задачи, связанные с данной
Add queue, Bot Runner, and device pool
Add a queue, Bot Runner, and device pool to the automation from the Run bot with queue page.

Move a бот
As a Bot Creator, you can now move your боты and files from one folder to another with ease in the
private workspace. If a бот is placed in an incorrect folder, you no longer have to clone it in the correct
folder and then delete it from the incorrect folder.
When you are moving a бот, keep the following considerations in mind:
• You can move only боты and files. You cannot move folders.
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• You can move only newly created боты and files. Checked-out, edited, and cloned боты cannot be
moved.

1. Log in to the Control Room as a Bot Creator user.
2. Select the бот or file to move. Hover over the actions menu (vertical ellipsis) located to the right of the

бот or file name and click Move Task Bot.
3. Browse and select the folder to which you want to move the бот and click Choose.

The бот is copied to the destination folder and removed from the source folder.

Прим.:
• When the бот is moved, you will see a warning message to change the reference in all the parent

боты.
• You can move a folder or a sub-folder into another folder when the number of items in the folder is

less than 100. An error message is displayed if the folder contains more than 100 items (including
metadata).

Check in a бот
Check in the бот files or folders to the public workspace from private workspace to make it available for all
users who have the permission to access and run the бот.
• You must have Bot Creator or Непрофессиональный разработчик license to check in a бот to the

public workspace.
• You must be assigned a custom role with the following permissions:

• Required: Check in permission at the folder level and at the corresponding parent folder level in the
public workspace.

• Необязательно. Create folder permission.
• Необязательно. View packages permission.

• To check in a бот with dependent folders and files, ensure you have the following:
• Create folder permission.

If you are checking in a бот from your private workspace and if the folder in which the бот is
present does not yet exist in the public workspace, you must have create folder permission to
successfully check in the бот.

• Check in permission on the dependency folder.

• Ensure that your private and public workspaces have the same folder structure so that when you
check in a бот from your private workspace, it will appear in the same folder structure in the public
workspace.

• For example, if you check in a бот from the sample бот folder in the private workspace, it will appear in
the sample бот folder in the public workspace.

If you want to check in multiple боты as a unit that are not dependent on each other, create a main бот
and then add the other боты as dependencies to this main бот. Check in the main бот.
1. Войдите в Control Room как пользователь Bot Creator или Непрофессиональный разработчик.
2. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
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3. You can choose to check in either one бот or multiple боты simultaneously.
• Select the бот that you want to check in, click the actions menu (vertical ellipsis), and click Check

in Task Bot.
• Select the боты that you want to check in and click Check in checked items.

Прим.:  You can check in up to 10 боты at a time.

4. In the Check in Task Bot window, add your comment and select the dependencies you want to
check in and click Check in checked items.
The бот appears in the same folder structure in the public workspace. Directly referenced
dependencies are automatically checked in.

Прим.:
• You cannot check in a бот file if another бот file already exists in the same location in the public

workspace.
• When you check in a бот along with a cloned бот and no other боты are dependent on the clone,

the cloned бот is deleted.

If you have issues in checking in a bot, see Unable to check-in the bots in Automation 360 (A-People login
required).

Checking out a бот and dependencies
The check out process enables you to create an editable copy of the бот in the private workspace from the
public workspace for further modification.
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After you have modified the бот, you can check in the bot again to the public workspace so that it can be
deployed by all users who have permission to access it. You can choose the specific version of the бот and
its dependencies (бот and non-бот) during the check-out process.
You can cancel the checked-out бот from your private workspace whereas an administrator can cancel the
checked-out бот from the public workspace. This releases the бот for another user who has access in the
public workspace. When you cancel check out, the бот status changes to Public in the public workspace.
In the private workspace, the status changes to New if any edits are made to the бот. Если изменений
нет, то бот заменяется клоном.

Guidelines for checking out боты

While checking out a бот, keep the following considerations in mind:
• Если вы хотите выгрузить несколько боты как единое целое и они не зависят друг от друга,

создайте основной бот, а затем добавьте другие боты в качестве зависимостей к этому главному
бот. Проверьте основной бот.

• Only one user can check out a бот at a time. When a user checks out a бот, it cannot be checked out
by any other user.

• Если вы выгружаете родительский бот в общедоступной рабочей области, зависимости которой
проверяются другим пользователем, зависимости родительского бот будут клонированы в вашу
личную рабочую область.

• Если бот выгружен, его нельзя удалить. The бот should be in a checked-in (Public) state to be
deleted.

• При редактировании выгруженного бот, статус изменяется на Выгружен, отредактирован.
Вы можете использовать параметр Отменить изменения для отмены изменений, внесенных в
выгруженный бот.

• Во время выгрузки клонированный бот может быть перезаписан или заменен.
• Зависимые файлы автоматически клонируются, если они выгружены другим пользователем и у

вас есть разрешение Клонировать для папки бот.

Prerequisites for checking out боты and dependencies

• Чтобы выгрузить бот в личную рабочую область, у вас должна быть лицензия Bot Creator или
Непрофессиональный разработчик.

• У вас должно быть разрешение на выгрузку на уровне папки.
• У вас должно быть разрешение на выгрузку зависимых папок, чтобы выгружать бот с

соответствующими папками и файлами.
• Чтобы отменить извлечение, выполненное пользователем Bot Creator, у вас должны быть

разрешения на операции Отменить извлечение и Смотреть содержимое для общедоступной
рабочей области.
Для отмены выгрузки бот из личного рабочего пространства разрешение на операцию Отменить
извлечение не требуется.

Checking out боты

You can check out single or multiple боты along with their dependencies. You can also choose the version
of the бот and their dependencies during the check out.
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• Check out a single bot
• Check out multiple bots
• Check out file dependencies

Check out a single бот
Check out the specific version of a parent бот and its dependencies from the public workspace to the
private workspace to create an editable copy of the бот.
Prerequisites for checking out бот and dependencies

1. Войдите в Control Room как пользователь Bot Creator или Непрофессиональный разработчик.
2. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
3. Select the бот, choose to either clone or check out the dependencies, open the actions menu (vertical

ellipsis) and click Check out Task Bot.

Прим.:  If a бот has multiple versions, you can select and check out the specific version of the бот
using Advanced options. Это позволяет откатиться к более ранней версии бот.

Вариант Шаги

Yes, Checkout Select this option to check out the latest
version of a бот. Зависимости клонируются
автоматически.
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Вариант Шаги

Расширенные параметры Select this option to select a specific version of
the parent бот and dependencies.
a. Click Advanced optoins.
b. Select the version of the parent бот to check

out.
c. Add or remove dependencies to check out.
d. Select the version of the dependency (бот or

non-бот) to check out.
e. Review the dependencies (Overwritten,

Missing, Cloned, Skipped).
f. Щелкните Выгрузить.

The бот appears in the same folder structure in the private workspace. When you check out бот files
or folders, all the dependencies linked to the бот files or folders will either be checked out or cloned
according to your choice.

4. Чтобы отменить выгрузку бот, щелкните параметр Отменить выгрузку TaskBot.
Этот параметр можно использовать как в общедоступной, так и в личной рабочей области.
In the public workspace, the бот status changes to public, and the бот is available for check out by
another user with the appropriate permissions.
In the private workspace, the бот status changes to new if any changes are made to the бот. Если
изменений нет, то бот заменяется клоном.

Check out multiple боты
Check out the specific versions of the parent боты and its dependencies from the public workspace to the
private workspace to create an editable copy of the бот.
Ensure you have completed all the prequisites for checking out боты:
• Prerequisites for checking out бот and dependencies
• Check out up to 10 parent боты at a time
• Check out only the latest version of the бот

1. Войдите в Control Room как пользователь Bot Creator или Непрофессиональный разработчик.
2. На левой панели щелкните Автоматизация.

Отобразится список доступных боты и форм.
3. Select the боты you want to check out and from the table level icons, click Check out checked

items.

Прим.:  You can check out up to 10 parent боты at a time. You can check out only the latest version
of the бот and its dependencies.

Вариант Шаги

Выгрузить… Select this option to check out the latest version of a бот. Зависимости
клонируются автоматически.
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Вариант Шаги

Расширенные
параметры

Select this option to review the information about the бот and
dependencies which can be checked out, skipped, cloned and click Check
out.
• The Files tab displays the бот files that can be checked out.
• The Checkout Dependencies tab displays the dependencies which

you can choose to check out.
• The Review dependencies tab displays the information on the

dependencies which are Overwritten, Missing, Cloned, or Skipped.

The бот appears in the same folder structure in the private workspace. When you check out бот files
or folders, all the dependencies linked to the бот files or folders will either be checked out, cloned,
skipped, or overwritten. Подробнее см. в разделе Considerations for checking out multiple боты.

Considerations for checking out multiple боты
There are certain considerations you have to keep in mind when checking out multiple боты.
• You can check out up to 10 parent боты at a time.
• You can only check out the latest version of the бот. You cannot select a specific version of the бот to

check out.
• During check out of multiple боты, the parent боты and their dependencies are either checked out,

cloned, skipped, or overwritten depending on different scenarios.

The following table explains the different scenarios of the parent боты and their dependency behavior
during check out of multiple боты.

Scenario Behavior

Parent бот not checked out by the
current user

The parent бот is checked out as part of the bulk checkout
and is shown in the check-out section of the basic flow.

Dependency not checked out by the
current user

The dependency is checked out as part of the bulk check out
and is shown in the check-out dependencies section of the
advanced flow.

Parent бот is already checked out
by the current user

The parent бот is not re-checked out and is shown in the
skipped section of the basic flow.

Dependency already checked out by
the current user

The dependency is not re-checked out and is shown in the
skipped section of the advanced flow.

Dependency checked out by other
users

The dependency is cloned during bulk check out.

Parent бот already cloned by the
current user and requiring a check
out

The parent бот is checked out as part of the bulk checkout,
and the clone will be replaced with the checked out bot.

Dependency already cloned by the
current user and requiring a check
out

The dependency is checked out as part of the bulk checkout,
and the clone will be replaced with the checked out бот.

Dependency already cloned by the
current user and is shown again for
cloning in bulk check out

The dependency is not re-cloned and is shown in the skipped
section of the advanced flow.
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Scenario Behavior

Parent бот is in new status in
private workspace

During bulk check-out, the user is provided an option to
overwrite the бот in the basic flow.

Dependency is in new status in the
private workspace

If the dependency is to be checked out, it is shown in the
overwrite section of the advanced flow. If the dependency
is to be cloned, it is shown in the cloned section of the
advanced flow.

Clone a бот
Create a read-only copy of the бот from the public workspace to the private workspace so that you can
have a local copy without checking out the bot.
• Create a user with a Bot Creator license.
• Create a custom role with the clone permission assigned at the folder level to the user.
• To clone a dependency folder, you must have the clone permission on the dependency folder.

Cloning a бот does not affect other users' access to the бот in the public workspace. A бот can be cloned
by multiple users.
1. Log in to the Control Room as a Bot Creator user.
2. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
3. Select the бот you want to clone, click the actions menu (vertical ellipsis), and click Clone Task Bot.

The cloned бот appears in the same folder structure in the private workspace.

Delete a бот
If you are a Control Room administrator or user with Delete from Public permission, you can delete
боты from the public workspace. If you are a Bot Creator, you can delete боты from your private
workspace.
To delete a бот, ensure the following:
• Public workspace: You must have the Control Room administrator role or the Delete from Public

permission at the folder level.
• Dependent folders and files: You must have the Delete from Public permission on these folders

and files.
• Private workspace: У вас должна быть лицензия Bot Creator.

You cannot restore a deleted бот, so ensure that you no longer require a бот before deleting it.

Прим.:  After you delete a бот, if you immediately create a бот with the same name as the deleted бот
and create it in the same folder, an error is displayed in some cases. To avoid this error, after you delete
a бот, wait for at least 5 seconds for the deletion to be completed. You can create another бот with the
same name as the deleted бот and in the same folder.
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• Delete боты from a private workspace:
In a private workspace, you can delete only боты that are in the New or Cloned status. You cannot
delete a бот in the Checked out or Checked out and edited status.
a) Log in to the Control Room as a Bot Creator.
b) На левой панели щелкните Автоматизация.

A list is displayed with the available files and folders containing the боты.
c) From the Automation page, choose one of the following methods to delete a бот:

Вариант Действие

Specific бот a. Select the бот.
b. Hover over the actions menu (vertical ellipsis) located to

the right of the бот name and click Delete Task Bot.
c. Click Yes, delete.

Multiple боты a. Select the check boxes corresponding to the боты, and
click Delete checked items.

b. Click Yes, delete.

• Delete боты from a public workspace:
In the public workspace, you can delete only боты that are in the Public status. You cannot delete
боты that are in the Checked out status.
a) Log in to the Control Room as an administrator, a Bot Creator, or an attended or unattended Bot

Runner user with Delete from Public permission.
b) На левой панели щелкните Автоматизация.

A list is displayed, with the available files and folders containing the боты.
c) From the Automation page, choose one of following methods to delete a бот:

Вариант Действие

Specific бот a. Select the бот.
b. Hover over the actions menu (vertical ellipsis) located to

the right of the бот name and click Delete Task Bot.
c. Click Yes, delete.

Multiple боты a. Select the check boxes corresponding to the боты, and
click Delete checked items.

b. Click Yes, delete.

Preload пакеты
You can preload пакеты on your local device to shorten the бот runtime.
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When you run a бот, the system downloads the бот and all the пакеты used in the бот. Бот execution
begins when the download is complete. If the пакеты used in the бот are preloaded, the system can skip
downloading the пакеты and start executing the бот, thereby reducing the бот execution timeframe.
Folder path: Preloaded пакеты are stored in \ProgramData\AutomationAnywhere\GlobalCache
on the local device.
If there are multiple versions of a пакет, only the default пакет is preloaded. You can only preload пакеты
on your local device. For the option to be available, the automatically download preloaded пакеты setting
must be enabled by the Control Room admin.

Прим.:  You can also save specific versions of пакеты that are used in боты offline to save the time it
takes to download these пакеты from the Control Room. The specific version of пакеты are stored in the
C:\ProgramData\AutomationAnywhere\AAPreloadedPackages folder.

Perform the following steps to preload пакеты on your local device:
1. Log in with a Bot Creator account.
2. Click the Manage > Devices > Preload package icon in the menu list for your local device.

Прим.:  The Preload package option is also available from the device icon drop-down menu for
Automation 360 Cloud through the Google Chrome browser with the Chrome plug-in enabled.

3. In the Preload packages window, preload either all пакеты listed on the Common packages page,
or select individual пакеты from the Customize packages page.
Common пакеты are the most lightweight and most commonly used ones.

4. Click the Start preloading option.

Copy a бот
Copy a бот to create a duplicate sequence of actions within your private repository. The copy retains the
meta-data of the original bot including captured images, recorded objects, called files, and child боты.
To copy a бот, follow these steps:
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Mouse over the actions menu.

The actions menu is the vertical stack of three dots to the left of each бот.
3. Click the Copy Task Бот icon.
4. In the Name field, enter a name for the duplicate бот.

Важное замечание:  Бот name must be unique. If a бот with the same name exists in the same
folder location which you have access to in the public workspace, you will not be able to copy the бот
with this name in the private workspace.

5. Необязательно: Click Browse to select the folder where to save the бот.
6. Click Copy.

The duplicate бот appears in the specified folder.
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View TaskBot version history
View the history of the changes that have occurred in your TaskBots. Вы можете определить действия,
выполненные пользователем в определенный день и определенное время, а также посмотреть
сообщения о загрузке.
You must have either check-in or check-out permissions.
You can view the version history of the TaskBots available in the public workspace and the private
workspace (only if there are checked-out боты). However, there is no version history available for new and
the cloned TaskBots.
The check-in or the check-out permission is required for the Bot Runner to view the version history.
However, note that this permission cannot be used by the Bot Runner to check in or check out bots.
1. Войдите в Control Room.
2. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
3. View the version history of TaskBots in the following ways:

• Select the TaskBots for which you want to view version history. Hover over the actions menu
(vertical ellipsis) located to the right of the TaskBots name and click View history Task Bot.

• Click the бот name. When the бот open, click the vertical ellipsis at the top-right corner and select
the View history Task Bot option.

A message appears listing all the versions of the selected бот in a sequence (latest revision on the top
and the first revision is at the end). The information includes the version number, check-in message,
checked-in date and time, and checked-in by username.

Assign label to a бот
You can now assign a production label for a particular version of a бот. You can use this label to choose
the version on which you want to perform certain бот operations. С помощью выбранной вами версии
вы можете планировать, выполнять, ставить в очередь, экспортировать и запускать потоки
операций разработки бот.
• You must have a custom role with the Label bots permission.
• You can apply labels only to the боты that are checked in to the public workspace.

1. Войдите в Control Room.
2. On the left panel in the public workspace, click Automation.

Отобразится список доступных боты и форм.
3. Select a бот, hover over the Actions menu (vertical ellipsis) on the right of the бот name, and click

Label Task Bot.
A list of available versions of the бот is displayed.

4. Select the version of the бот to which you want to apply a label.
5. Click the right arrow (→) to add your selection.
6. Click Apply Label.

The label Production is now assigned to the бот.

Прим.:  Если для родительского бот выбран вариант «Метка производства», то автоматически
выбираются также соответствующие зависимые боты с меткой производства. Если какие-либо
из зависимых боты не имеют метки производства, выбирается последняя версия бот. However,
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if the dependent бот is called through Task Bot > Run > Variable > Control Room path option,
always the latest version of the бот is selected even if the production label is applied to the бот.

Редактирование бота
Edit бот logic using the Bot editor to add, modify, or delete actions and automation steps.

Open a bot

Open a bot in the Bot editor in one of the following ways:
• Select the бот and click Edit. The edit button is a pencil icon.
• Right-click on the бот and select Edit.
• Click Actions and select Edit.

Compare бот versions
You can compare different versions of your боты and view any modifications in your workflows in both the
public and the private workspaces.
Ensure you have the following permissions:
• View my bots
• View content
• Check in or Check out
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• Public workspace
a) Войдите в Control Room как пользователь Bot Creator или Непрофессиональный разработчик.
b) Navigate to the public workspace.
c) На левой панели щелкните Автоматизация.

Отобразится список доступных боты и форм.
d) Select a бот, hover over the actions menu (vertical ellipsis) on the right of the бот name, and click

Compare versions.
The compare version page appears with two versions of your бот. The left column shows the
previous version of your бот, and the right column shows the newer version of your бот.

e) Click the Change version icon to select and confirm the version of the бот that you want to
compare on the left and right column.
You can review the two versions of your бот. The red highlights on the left column show the lines
that are modified. The green or blue highlights on the right column show the lines that are added
or changed. This view shows the бот versions by Actions.

Прим.:  When you compare two versions of a бот, you might sometimes not observe any visible
changes. This is because the бот version is modified as a result of changes in the underlying JSON
file.

f) Необязательно: Select Variables, Triggers, Packages, or Dependencies to compare your бот
versions by these categories.

Прим.:  The changes made to the immediate dependencies are displayed, and the dependencies
are sorted in an alphabetical order.

g) Необязательно: Select the Swap versions icon to swap between your two current versions.
h) Click Close to exit the comparison view.
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• Private workspace
a) Войдите в Control Room как пользователь Bot Creator или Непрофессиональный разработчик.
b) Navigate to the private workspace.
c) На левой панели щелкните Автоматизация.

Отобразится список доступных боты и форм.
d) Select a бот, hover over the actions menu (vertical ellipsis) on the right of the бот name, and click

Compare versions.
The compare version page appears with the left column displaying the source checked-out version
of the бот in the public workspace and the right column displaying the checked-out and edited бот
in the private workspace.

e) Click Change version to change the current бот version in the left column (Public version).
The Select version to compare page prompts you to select a new бот version.

Прим.:  You cannot change version on the right column (Private version).

f) Select and confirm the version of the бот that you want to compare on the left column.
You can review the source and edited versions of your бот . The red highlights on the left column
show the lines that are modified. The green or blue highlights on the right column show the lines
that are added or changed. This view shows the бот versions by Actions.

g) Необязательно: Select Variables, Triggers, Packages, or Dependencies to compare your бот
versions by these categories.

Прим.:  The changes made to the immediate dependencies are displayed, and the dependencies
are sorted in an alphabetical order.

h) Click Close to exit the comparison view.

View бот dependency map
Теперь вы можете просматривать карту зависимостей для вашего бот в общей и личной рабочих
областях. Карта зависимостей показывает непосредственные родительские и дочерние боты для
любого выбранного бот. С помощью этой информации вы можете оценить влияние изменения в бот,
эффективно использовать бот, улучшить код бот и возможность его повторного использования, а
также предотвращать конфликты.
Ensure that you have the View content permission.

1. Войдите в Control Room.
2. На левой панели щелкните Автоматизация.

Отобразится список доступных боты и форм.
3. View the dependency map of the боты in the following ways:

• Select the бот for which you want to view version history. Hover over the actions menu (vertical
ellipsis) located to the right of the бот name and click View dependencies and references.

• Click the бот name. When the бот opens, click the vertical ellipsis at the top-right corner and select
View dependencies and references.
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4. Toggle between the Dependencies and References tabs to view the immediate parent and child
боты.
• Dependencies: Displays the боты or files that the бот uses to run
• References: Displays the боты or files that depend on the бот to run

Attach work item template to TaskBot
Attach a work item template to a TaskBot to use the TaskBot in workload automation.
When you attach a work item template to a TaskBot, you can use the variable $WorkItem$ that contains
the attributes for the required workload automation when you run the бот using the Run bot with queue
option.
Use Work Item variables

1. На левой панели щелкните Автоматизация.
Отобразится список доступных  и форм.

2. Create or edit a TaskBot from the Automation page.
The TaskBot opens in edit mode.

3. Select the option Work item template from the menu at the top-right of the Workbench.
The list of Work item templates appears.

4. Select the template that best suits your workload automation requirement.
5. Click the right arrow to add the template.

The Work item template attributes are listed for the selected template.
6. Щелкните Сохранить.
7. Choose one of the following actions:

• Click Close to return to the My bots page.
• Click Return to editor to continue editing the TaskBot.

Понятия, связанные с данным
Управление рабочей нагрузкой
Модуль управления рабочими нагрузками позволяет пользователям загружать файлы Microsoft Excel
и CSV в Control Room, чтобы записи из этих файлов попадали в развертывания бот.
Задачи, связанные с данной
Use Work Item variables
You can use the Work Item variables to pass the Work Item attributes or values to the TaskBot from the
Control Room when you run the бот with the option Run bot with queue.
Ссылки, связанные с данной
Рабочая нагрузка пакет
The Рабочая нагрузка пакет enables you to insert work items in a queue for workload automation. It also
enables data chaining between multiple queues. You can orchestrate multiple боты, and enable optimal
device utilization through the queueing mechanism of workload management.

View пакет versions available in the Control Room
Actions are grouped into version-specific пакеты. Bot Creator can select which пакет version to use for a
specific бот.
Обычные пользователи могут просматривать только пакеты, доступные в Control Room, а также
сведения о конкретных пакетах.
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Bot Creator требуется разрешение AAE_Basic, чтобы выбрать определенные пакеты для
использования в бот.
Go to the Manage > Packages page to view all the packages in the Control Room.

Пакеты updated in Automation 360 v.26

Важное замечание:
• For information about packages updated in v.27, see Пакеты updated in v.27
• For information about packages in releases previous to v.26, see the PDFs for these releases:

Предыдущие версии Automation 360.

The following table provides details about the updates in the пакеты for v.26:

Имя
Пакет

Версия Обновления
Пакет

Версия Bot Agent Версия Control Room

AARI web 7.0.1-20220727-162102 Нет 21.134 or later 12316 or later

Active
Directory

3.5.0-20220416-233339 Нет 20.11 or later 8750 or later

Analyze 2.4.4-20220615-020937 Нет 20.11 or later 8750 or later

Интеграция
приложений

4.8.0-20220616-123118 Defect fix 21.88 or later 10195 or later

Приложение3.5.0-20220416-233350 Нет 20.11 or later 8750 or later

Логический 2.5.0-20220118-153154 Нет 20.11 or later 8750 or later

Миграция
Бот

9.1.9-20220902-133838 • New
feature 1

• New
feature 2

• New
feature 3

• New
feature 4

• New
feature 5

• Defect
fix 1

• Defect
fix 2

• Defect
fix 3

21.220 or later 15224 or later

Браузер 3.6.1-20220802-062805 Defect fix 21.210 or later 14140 or later

Буфер
обмена

3.4.0-20220416-233509 Нет 20.11 or later 8750 or later

Комментарий2.11.0-20220419-061753Нет 20.11 or later 8750 or later

Credential 1.3.0-20220416-233509 Нет 20.11 or later 8750 or later
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Имя
Пакет

Версия Обновления
Пакет

Версия Bot Agent Версия Control Room

CSV/TXT 2.9.0-20220419-061754 Нет 20.11 or later 8750 or later

База
данных

4.9.3-20220804-174704 • Defect
fix 1

• Defect
fix 2

21.88 or later 10204 or later

Таблица
данных

4.5.1-20220509-073253 Нет 20.11 or later 8750 or later

Дата/время 2.8.8-20220628-071423 Defect fix 20.11 or later 8750 or later

Задержка 3.5.0-20220416-233521 Нет 20.11 or later 8750 or later

Словарь 3.8.0-20220505-214608 Нет 20.11 or later 8750 or later

DLL 6.6.1-20220617-052638 • Enhancement
• Defect

fix

21.200 or later 15238 or later

Document
Extraction

1.6.0-20221207-201734 Нет 21.98 or later 15345 or later

Эл. почта 3.13.1-20220713-173156• New
feature

• Defect
fix 1

• Defect
fix 2

• Defect
fix 3

21.210 or later 13980 or later

Триггер
эл. почты

2.7.3-20220714-073535 Defect fix* 21.210 or later 13980 or later

Обработчик
ошибок

2.9.0-20220127-062650 Нет 20.11 or later 8750 or later

Расширенный
Excel

6.10.4-20220714-144826• New
feature 1

• New
feature 2

• Defect
fix 1

• Defect
fix 2

21.112 or later 11307 or later

Базовый
Excel

6.10.3-20220630-102036Defect fix* 21.112 or later 11307 or later

Файл 6.4.0-20220615-171851 Defect fix 21.98 or later 10789 or later
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Имя
Пакет

Версия Обновления
Пакет

Версия Bot Agent Версия Control Room

Файл и
папка

1.2.0-20220628-195259 Нет 20.11 or later 8750 or later

Папка 6.4.0-20220615-171851 Defect fix 20.11 or later 8750 or later

FTP / SFTP 2.8.1-20220530-074610 • Defect
fix 1

• Defect
fix 2

20.11 or later 8750 or later

Genesys 1.0.4 Нет 21.210 or later 14199 or later

Google
Календарь

2.8.1-20220623-122146 Defect fix* 20.11 or later 8750 or later

Google
Диск

2.8.1-20220623-094335 Defect fix* 20.11 or later 8750 or later

Google
Document
AI

1.2.0-20220616-091303 Defect fix* 21.98 or later 10520 or later

Google
Таблицы

2.9.2-20220628-052504 Defect fix* 20.11 or later 8750 or later

Google G
Suite

2.8.0-20220416-235104 Нет 20.11 or later 8750 or later

Hot key 1.1.0-20220715-220729 Нет Нет Нет

Если 3.4.0-20220127-062702 Нет 20.11 or later 8750 or later

Распознавание
изображений

3.11.0-20220623-052117Defect fix* 21.210 or later 14100 or later

Интерактивные
формы

2.26.2-20220728-053945• New
feature

• Defect
fix

20.11 or later 8750 or later

Interface
trigger

1.5.0-20220812-185225 Нет 20.11 or later 8750 or later

IQ Bot 2.2.5-20221107-102303 Нет 21.98 or later 10520 or later

IQ Bot
Pre-
processor

2.2.5-20221107-101937 Нет 21.98 or later 10520 or later

JavaScript 2.13.0-20220620-094839Defect fix* 20.11 or later 8750 or later

JSON 1.1.0-20220419-055641 Нет 21.98 or later 10520 or later

Legacy
AISense

1.8.0-20220714-195459 • Defect
fix 1

• Defect
fix 2

21.220 or later 15224 or later
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Имя
Пакет

Версия Обновления
Пакет

Версия Bot Agent Версия Control Room

Legacy
Automation

5.3.1-20220804-175600 Defect fix 21.200 or later 13279 or later

Список 2.8.0-20220118-153952 Нет 20.11 or later 8750 or later

Записать
в файл

3.5.0-20220416-233918 Нет 20.11 or later 8750 or later

Цикл 3.5.0-20220416-233919 Нет 20.11 or later 8750 or later

Message
Box

3.4.0-20220416-233919 Нет 20.11 or later 8750 or later

Мышь 2.12.3-20220616-131218Defect fix* 21.210 or later 14100 or later

Число 3.5.0-20220416-233938 Нет 20.18 or later 9130 or later

Распознавание
текста
(OCR)

2.10.0-20220502-204318Нет 21.118 or later 8750 or later

Календарь
Office 365

2.8.1-20220516-181356 Нет 20.11 or later 8750 or later

Office 365
Excel

2.9.1-20220516-182121 Нет 20.11 or later 8750 or later

Office 365
OneDrive

2.8.1-20220516-182128 Нет 20.11 or later 8750 or later

PDF 3.6.0-20220616-054613 • Defect
fix 1

• Defect
fix 2

21.31or later 9300 or later

PGP 3.4.0-20220118-154220 Нет 21.88 or later 10195 or later

Ping 3.4.0-20220416-234250 Нет 20.11 or later 8750 or later

Воспроизвести
звук

2.6.0-20220421-071315 Нет 20.11 or later 8750 or later

Принтер 2.4.0-20220118-154256 Нет 20.11 or later 8750 or later

Триггер
процесса

1.3.0-20220118-154818 Нет 21.112 or later 11314 or later

Обнаружение
процессов

2.1.13-20220712-150821Нет 21.128 or later 12247 or later

Запрос 2.6.0-20220118-154257 Нет 20.11 or later 8750 or later

Python
Script

2.12.0-20220812-184521Нет 20.11 or later 8750 or later

Запись 1.5.0-20220505-215415 Нет 20.11 or later 8750 or later
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Имя
Пакет

Версия Обновления
Пакет

Версия Bot Agent Версия Control Room

Средство
записи

2.8.6-20220823-160834 • New
feature 1

• New
feature 2

• Defect
fix 1

• Defect
fix 2

• Defect
fix 3

• Defect
fix 4

• Defect
fix 5

• Defect
fix 6

• Defect
fix 7

21.210 or later 14068 or later

Веб-служба
REST

3.11.1-20220714-082239• New
feature 1

• New
feature 2

• Defect
fix

20.11 or later 8750 or later

Salesforce 1.2.0-20220725-133902 New feature 21.119 or later 15422 or later

SAP 3.7.1-20220616-055414 New feature 21.88 or later 10195 or later

SAP BAPI 2.7.0-20220424-053247 Нет 21.2 or later 9249 or later

Экран 2.8.0-20220426-033753 Нет 20.11 or later 8750 or later

Служба 4.5.0-20220416-234715 Нет 20.11 or later 8750 or later

Триггер
службы

1.5.1-20220425-083711 Нет 21.112 or later 11314 or later

Имитация
нажатия
клавиш

3.9.2-20220620-185233 Defect fix* 21.200 or later 13297 or later

SNMP 2.5.0-20220419-063009 Нет 20.11 or later 8750 or later

Веб-служба
SOAP

3.12.1-20220715-125139• New
feature

• Defect
fix*

21.90 or later 10227 or later

Шаг 2.3.0-20220715-220724 Нет 20.11 or later 8750 or later

Строка 5.4.2-20220412-134724 Нет 20.18 or later 9130 or later
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Имя
Пакет

Версия Обновления
Пакет

Версия Bot Agent Версия Control Room

Система 3.9.2-20220421-100102 Нет 21.88 or later 10217 or later

TaskBot 2.4.0-20220628-195240 Нет 20.11 or later 8750 or later

Эмулятор
терминала

4.7.1-20220728-125827 • New
feature

• Defect
fix 1

• Defect
fix 2

21.93 or later 10353 or later

Текстовый
файл

1.3.0-20220416-235037 Нет 20.11 or later 8750 or later

Триггерный
цикл

0.7.0-20220715-220725 Нет 20.11 or later 8750 or later

TaskBot V111.12.1-20220707-062607Defect fix 20.11 or later 8750 or later

VBScript 2.16.0-20220628-195244Defect fix* 21.210 or later 14100 or later

Ожидать 4.5.0-20220416-235041 Нет 20.11 or later 8750 or later

Окно 5.7.1-20220804-040754 • New
feature

• Defect
fix 1

• Defect
fix 2

20.11 or later 8750 or later

Триггер
Окно

1.4.0-20220118-154823 Нет 20.11 or later 11314 or later

Рабочая
нагрузка

2.10.1-20220512-164301Нет 20.11 or later 8750 or later

XML 3.6.0-20220530-054638 Defect fix* 20.11 or later 8750 or later

* These fixes do not include information in our documentation site, so no links are provided.

Select the package version used in your бот
As a Bot Creator you have the ability to select which package version to use for a set of actions within your
бот.
You need to have AAE_Basic permission.

Совет:  For existing боты, follow these steps to update to the default package.

1. Open or create a new бот from Automation page.
2. Click the vertical ellipses in the upper right corner, and select Packages.

Прим.:  The packages used in the selected бот are highlighted.

3. Click the drop-down list to view which version of the package is currently used for this бот.
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4. To change the package version to be used for this бот, select the package version to use from the
drop-down list of available packages.

5. Click Change version.
6. Щелкните Сохранить.

Версия совместимости Бот
Бот compatibility version provides internal versioning for бот compilation and helps track different runtime
behaviors for specific features. Compatibility version helps to maintain backward-compatibility when there
are breaking changes (when you make changes in one part of the code that can cause potential issues in
other areas).

Available compatibility versions

Бот compilation occurs on the device where the Control Room is located. Typically a Windows or Linux
device is used based on the deployment model (Windows for On-Premises and Linux for Cloud).
Depending on your requirements, choose one of the following versions:

Версия Описание

1 The бот file path is parsed at compilation time

2 The бот file path is parsed at бот runtime depending on the device on which
the бот is running
For example, the UNC (universal naming convention) path format is different
for Windows and Linux. When you choose this version, a message is sent to
the бот compiler to parse the file path during runtime instead of at compilation
time.

3
(Default)

The global value used in the parent бот is carried over to the child бот using a
shared cache for the entire бот run which recduces the бот execution time.

Set the бот compatibility version

As a Bot Creator, you can set the бот compatibility version in the private workspace.
1. Войдите в Control Room.
2. In the private workspace, select the бот for which you want to set the version.

The бот opens in edit mode.
3. From the actions menu (vertical ellipsis), select Advanced settings.
4. If the Bot compatibility version is set to 1 or 2, we recommend that you set it to 3 (default

version) to enhance performance when using global values. Ensure that the parent бот and all the
child боты have the Bot compatibility version set to 3.

Прим.:  If you set the Bot compatibility version to 1, the bot runtime might be impacted; and if
you set it to 2, then the бот execution time might increase when using global values across боты.
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5. Необязательно. Select the Enabled improved number support check box in the Advanced
features field.
This setting helps in accurate float number calculation (positive or negative whole number with a
decimal point) for your new боты.

6. Return to the бот editor and save the бот.

Compatibility version for migrated боты

After migration from Enterprise 11 to Automation 360 and if you have removed the AAApplicationPath
from the destination path, your бот might fail. For more information on how to resolve this issue, see
Migrated bots and compatibility versions.

Set automation priority for your боты
Set the automation priority of your боты to high, medium, or low so that higher-priority automations are
processed first for deployment. This enables you to meet your business SLA (service-level agreement) for
resource optimization.

• У вас должна быть лицензия Bot Creator.
• You must be assigned the Set automation priority to high permission.

You can set the automation priority when you create and edit a бот.
1. Log in to the Control Room as a Bot Creator user.
2. In the private workspace, select a бот for which you want to set the priority.

The бот is opened in edit mode.
3. From the actions menu (vertical ellipsis), select Advanced settings.
4. Set the Automation priority to high, medium, or low based on your requirements.

When боты are queued for a Bot Runner user, боты with higher priority are deployed before боты
with lower priority. However, if a бот with lower priority is already running, боты with higher priority
are deployed after the бот with lower priority completes running.
По умолчанию для разрешения установлено значение «средний».

5. Return to the бот editor and save the бот.

Настройте время ожидания выполнения для бот
Укажите время, в течение которого система должна ожидать до прекращения работы бот, когда тот
не отвечает или требует для выполнения задачи больше времени, чем ожидалось.
Когда время ожидания для задачи истекает, любые последующие задачи (задачи в очереди) могут
выполняться без каких-либо проблем.
Время ожидания для задачи не применяется в указанных ниже сценариях.
• Когда задача приостанавливается вручную.
• Если задача выполняется в режиме отладки.
• Если задача вызывается с использованием action Запустить из пакет TaskBot.
• Когда первая задача в процессе приостанавливается, дополнительные задачи отменяются, и

первая задача возобновляется.

1. Войдите в Control Room.
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2. На левой панели щелкните Автоматизация.
Отобразится список доступных  и форм.

3. Откройте бот, для которого хотите установить время ожидания.
4. Выберите Расширенные настройки в меню действий (вертикальное многоточие) в правом

верхнем углу.
5. В поле Время ожидания укажите время, в течение которого система должна ожидать до

отмены выполнения бот.
По умолчанию в поле Время ожидания установлено нулевое значение (0) и система ожидает,
когда бот завершит выполнение.

6. Вернитесь в Bot editor и сохраните изменения для бот.

Создание и переименование папок
Depending on the permission assigned to you, you can create or rename folder names and description in
the private workspace and rename the folder description in the public workspace. This helps to organize
your боты and files in the Control Room repository.
Для создания папок необходимы следующие разрешения.
• Просмотреть мои боты
• Создать папки

Для переименования папок необходимы следующие разрешения.
• Просмотреть мои боты
• Переименовать папки

You can grant access privileges to other users to specific folders so that they can perform various бот
operations on the боты contained in that folder. При переименовании папки учитывайте следующее.
• Переименовывать папки с содержимым можно только в личном рабочем пространстве.
• При переименовании папки проверьте, что выполняются следующие условия.

• Она не содержит выгруженных или клонированных боты даже на уровне вложенных папок.
• Она содержит не более 100 элементов, включая вложенные папки и файлы.

• Создать папку
a) Перейдите в раздел Автоматизация > Папка.
b) Щелкните по папке в древовидном представлении Папки, чтобы открыть ее. Например,

Bots > Sample bots.
c) Щелкните по значку для создания вложенных папок на вкладке Папка и укажите

соответствующее имя.
d) Найдите и выберите путь, где вы хотите сохранить папку.
e) Щелкните Создать папку.

Папка добавлена и ее можно просмотреть в древовидном представлении Папки и на
вкладке Файлы и папки.
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• Rename a folder in the private workspace
a) Перейдите в раздел Автоматизация > Папка.
b) Щелкните по папке в древовидном представлении Папки, чтобы открыть ее. Например,

Bots > Sample bots.
c) На вкладке Файлы и папки наведите курсор на папку, которую вы хотите переименовать, и

щелкните Редактировать папку (значок карандаша).
d) Provide an appropriate name and description and browse and choose the path to the location

where you want to save the folder.
e) Щелкните Сохранить изменения.

• Edit folder description in the public workspace
a) Перейдите в раздел Автоматизация > Папка.
b) Щелкните по папке в древовидном представлении Папки, чтобы открыть ее. Например,

Bots > Sample bots.
c) На вкладке Файлы и папки наведите курсор на папку, которую вы хотите переименовать, и

щелкните Редактировать папку (значок карандаша).
d) Enter a meaningful description and then browse to select the location where you want to save the

folder.
e) Щелкните Сохранить изменения.

Keyboard shortcuts
List of keyboard shortcuts supported.

All modes - Flow or List view

In the Bot editor, you can open a menu to display available keyboard shortcuts.
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Keys Действие

Esc Closes node details or clear cursor

Табуляция Toggles Flow or List view

Ввод Shows node details and focus first input

Space Toggles node details

Ctrl A Selects all nodes

All modes - Flow view

Keys Действие

Вверх Moves cursor up

Вниз Moves cursor down

Влево Moves cursor left

По правому краю Moves cursor right

All modes - List view

Keys Действие

Вверх Moves cursor up

Вниз Moves cursor down
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Edit mode

Keys Действие

Ctrl S Saves file

F5 Запустить

F10 Enters debug mode

Shift F9 Toggles all breakpoint

Edit modes - Flow or List view in focus

Keys Действие

Ctrl Shift R Starts recording

Ctrl / Enables or disables mode

F9 Toggles node breakpoint

Ctrl C Copy node

Ctrl X Cut node

Ctrl V Paste node

Удалить Удалить узел

Ctrl Z Отменить

Ctrl Y Вернуть

Debug mode

Keys Действие

F5 Play/pause/restart

F6 Step next

F7 Остановить

F10 Exits debug mode

Shift F9 Toggles all breakpoints

Debug mode - Flow or List view in focus

Keys Действие

F9 Toggles node breakpoints
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Node details

Keys Действие

Ctrl Enter Accepts current input and saves the action or trigger

Variables overview
Automation 360 offers a variety of variables, each designed to hold specific types of data and is intended
for specific use. Use the topics below to learn more about each variable and how to use them.

Using variables

The following table describes how Automation 360 passes variable values between a parent and child бот
when using different data types:

Тип данных Пример Behavior

Primitive data type (stores a
single value)

String, Number, or Boolean You create a parent and a child
бот using primitive data types
and run the TaskBot. When the
parent бот passes a variable
to the child бот through input
variables, and if you change the
values of those variables in the
child бот, the changes are not
saved when execution returns
to the parent бот. When you
use primitive data types, the
variable's actual value is passed,
and any changes made to these
variables in the child бот are
not reflected in the parent бот.

Non-Primitive data type (stores
multiple values)

List, Dictionary, or Record You create a parent and child
бот using non-primitive data
types and run the TaskBot.
When the parent бот passes
a variable to the child бот
through input variables, and
if you change the values of
those variables in the child бот,
the changes are saved when
execution returns to the parent
бот. When you use the non-
primitive data types, the values
are passed by reference, and
any changes made to these
variables in the child бот are
reflected in the parent бот.

Пример. You created a parent and child бот using the following variables:
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• VarList: Employee data (First name, last name, Date of birth)
• VarString: Employment type (Permanent)
• VarNumber: 100

You used the same variables in the child бот with the Use as input check box selected.
In the child бот, you updated the following values:
• Added a new detail in the VarList variable as Employee data (Date of Joining)
• Changed the value of the VarString variable to Employment type (Contract)
• Changed the value of the VarNumber variable to 50

When the parent бот calls the child бот, and the execution returns to the parent бот, the List variable will
show the updated values, whereas the String and Number variable values will not change:
• VarList: Employee data (First name, Last name, Date of birth, Date of joining)
• VarString: Employment type (Permanent)
• VarNumber: 100

Credentials and credential variables in the Bot editor Use credentials when building боты to pass
sensitive information such as passwords and
account numbers. Using credentials separates
the sensitive information from the боты and Bot
Runner, which reduces the risk of data spillage or
unauthorized user access.

Предварительно определенные переменные Predefined (or system) variables return the specific
values about the machine on which the бот
is executed. Users cannot edit the values of a
predefined variable.

Your variables (user-defined) Users and some actions create user-defined
variables to temporarily hold values. Use this kind of
variable to input values into an action (window title,
login credential, or file path) or to accept the output
of an action (values read from a file or a Boolean
return).
Create a variable

Глобальные значения Global values enable users to reuse identical values
between боты instead of creating new variables
for each бот. A user with the AAE_admin role
configures a global value with a default value and
can enable non-admin users to overwrite the value
to use in their боты.

Work Item variables You can use the Work Item variables to pass the
Work Item attributes or values to the TaskBot from
the Control Room when you run the бот with the
option Run bot with queue.

Предварительно определенные переменные
Predefined (or system) variables return the specific values about the machine on which the бот is
executed. Users cannot edit the values of a predefined variable.
Predefined variable types include clipboard, date time, string and system settings and parameters.
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Прим.:  System variables are called as predefined variables in Automation 360.

Буфер обмена

Use the actions in the Буфер обмена package to perform operations on the clipboard variable. См. раздел
Буфер обмена пакет.

Переменная Описание

Clipboard Returns the contents of the clipboard.

Date time

Use the actions in the Дата/время package to perform operations on the date time variables. Datetime
пакет

Переменная Описание

Date Returns the date including hours, minutes, and seconds.

Прим.:  Hours can be in 24-hour or AM/PM format depending on the
machine configuration.

Day Returns the day in DD format.

Hour Returns the hours in HH format.

Machine Returns the device name as a string.

Millisecond Returns the milliseconds with a value between 0 and 999.

Minute Returns the minutes in MM format.

Month Returns the month in MM format.

Second Returns the seconds in SS format.

Year Returns the year in YYYY format.

Строка
Use the following variables to change how a string is displayed.

Переменная Описание

Enter Starts a new line without returning to the beginning of the line based
on the operating system of the device. For example, the variable
always adds a new line in Linux CentOS. In Microsoft Windows, the
variable adds a page break in the Microsoft Word application and a
new line in the Notepad application.

Newline Starts a new line and moves the cursor to the beginning of the next
line regardless of the application and operating system of the device.

Separator Demarcates a separation between values with a <sep> value.
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Переменная Описание

Tab Creates large space.

System settings and parameters

Use the following variables to return data from the computer that is connected to the running Bot Agent:

Переменная Описание

AAControlRoom Returns the URL of the Control Room.

AAInstallationPath Returns the Bot Agent installation path. For example, C:\Program
 Files\Automation Anywhere\Bot Agent.

AATaskExecutor Returns details on the Run-as user that is used to run a бот. If the
бот is deployed on an attended Bot Runner, this variable returns
information about the logged-in user. If the бот is deployed by a
trigger, this variable returns information about the user associated with
that Bot Runner license.
This variable is a dictionary with the following keys:
• Executor_UserName
• Executor_FirstName
• Executor_LastName
• Executor_Email
• Execution_type: Returns the type of execution

• When you schedule a бот to run, the Execution_Type key
in the AATaskExecutor variable returns information about the
execution type with the schedule type (frequency) such as Run
 as schedule <Daily, Weekly, or Monthly>.

• When you use a trigger in a бот, the Execution_Type
key can be accessed through the trigger data. The
Execution_Type key returns the Run through Trigger as
a string for triggers. The Execution_type can be used in all
the triggers.

AATaskInvoker Returns details on the user that deployed the бот either by running or
scheduling the бот. If the бот is deployed to an attended Bot Runner,
this variable returns information about the logged-in user. If the бот is
deployed by a trigger, this variable returns information about the user
who set the trigger.
This variable is a dictionary with the following keys:
• Invoker_Email
• Invoker_FirstName
• Invoker_UserName
• Invoker_LastName

AATaskName Returns the path and name of the currently running TaskBot. For
example, /Bots/Finance/combineSheets.atmx.
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Переменная Описание

CPUUsage Returns the percentage utilization of the CPU.
Use this variable in a Wait for condition action to make the бот wait
until machine CPU usage decreases to a specific amount. См. раздел
Ожидать пакет.

Machine Returns the name of the computer.

RAMUsage Returns the RAM usage in megabytes.
Use this variable in a Wait for condition action to make the бот wait
until machine RAM usage decreases to a specific amount. См. раздел
Ожидать пакет.

OSName Returns the operating system. For example, Windows 10 64-bit.

TotalRAM Returns the total amount of RAM available.

• Version 11.3 contained Email, File, and PDF system variables, which could hold a limited number of
properties values. In Automation 360, an infinite amount of Email, File, and PDF properties values are
stored in User-defined Dictionary variables. Для получения дополнительной информации см. Using
dictionary variable for email properties и Using a dictionary variable for PDF properties.

• Version 11.3 contained Excel system variables to return the cell, column, or row location. In Automation
360, the Excel Advanced пакет contains the following actions to return location values: Get cell address,
Get column, and Get row.

• Version 11.3 contained the Counter system variable to return the loop iteration count. In Automation
360, the user must create and configure a number variable.

Your variables (user-defined)
Users and some actions create user-defined variables to temporarily hold values. Use this kind of variable
to input values into an action (window title, login credential, or file path) or to accept the output of an
action (values read from a file or a Boolean return).
When you are building automated tasks, some actions need to refer to and use some values, and these
values can be stored in variables. Variables can help you in several ways, from retrieving online data to
transferring data between applications, such as Microsoft Excel. A variable can hold one or more values.
The values that a variable can contain and the operations that can be performed on the variable are
determined by its data type.

Прим.:
• A бот can return only a maximum of 3 MB to an output variable. In addition, the table structure in

BotOutputVariable is limited to 300,000 cells.
If you insert more than 300,000 cells, an error message is displayed indicating that the debug variable is
too big to debug or that BotOutputVariable is too big to process.
Обходное решение. Store the бот output on the device, such as in a .txt file. If the output must be
shared across multiple Bot Runner, store the output in a shared drive.

• The size of bot input variables is limited to 1900000 bytes. We recommend you use .txt file to store
large data set.
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Variable types

The data type of a variable is an attribute that determines the kind of data that the value stored in the
variable can have. Data types include storage classifications, such as integers, strings, and characters.
Variables such as dictionary, record, list, or table can hold multiple data types.
Most variable types have a package with a similar name, which contains actions used to perform
operations on the values stored in the variable. For example, use the actions in the Строка пакет to work
on String variables. Similarly, to work on Number variables, use the actions in the Число пакет. To convert
the value of one variable type to another, see Type conversion

Variable naming

A variable name can contain a maximum of 50 Unicode characters, including numbers (0-9), Latin
letters (A-Z, a-z), and special characters (- and _). You can use double-byte characters, such as Chinese,
Japanese, or Korean characters, in a variable name. Unicode range supported in variables

We recommend using camel case for variable names and prefixing the variable name to indicate the scope
and data type. For example, iFileEmailAttachment for a file type variable that is used to provide an
input.

Прим.:  The following is a recommended naming standard for variables <type/scope
 indicator><data type><Variable name>. While there are many naming convention options,
some standards must be adopted and used consistently within the organization.
The <type/scope indicator> is a single character as follows:
• p = local variable (neither input nor output)
• i = input variable
• o = output variable
• io = input and output variable
• c = constant

Following are a few more examples for naming variables.
• iStrAuditLogPath: a string type variable received from a calling task
• oNumReturnValue : a number type variable returned to a calling task
• ioStrStatus: a string that is both received from and returned to a calling task
• cStrNull: a string that holds no value; for example, useful for string comparisons to check whether a

value is present

For more information about scope, see TaskBot пакет. This standard enables you to search for variables by
type. For example, oStr returns variables that are used to hold output string values.
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Variable types

Variable type and suggested
name

Описание Use examples

Любое
Any

Stores Boolean, Data table, Datetime, File,
Number, Record, String, or Window data
types. Use this variable type when you are
uncertain of which data type an action will
output.

Example of using the
Run action

Логический
Bool

Stores either a True or False value.

Credential
Cred

Stores string values securely, preventing
values from being displayed in a message
box or written to a file. The value is either
selected from the Credential Vault or is
user-provided.
Credentials and credential variables in the Bot
editor

Дата/время
Date

Stores a value containing a single date and
time value.

You can format the
values by selecting a
predefined format or
specifying a custom
format.
Datetime formats

Словарь
Dict

Stores data in the form of key-value pairs.
The value can be boolean, number, or
string.
Dictionary пакет

• Using dictionary
variable for email
properties

• Using a dictionary
variable for PDF
properties

Файл
File

Stores a file path.
Example of using a file variable

Форма
Form

Stores the value that was input into an
interactive form field.
Using interactive forms

Список
List

Stores a sequence of boolean, number, or
string values.

Список пакет
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Variable type and suggested
name

Описание Use examples

Число
Num

Stores numeric values, including integers
and decimals. В них хранятся значения
от -9 223 372 036 854 775 808 до
9 223 372 036 854 775 807 и до 15
десятичных разрядов.
You can assign a randomly generated value
to this variable.
Random number action

You can remove
the digits following
a decimal when
converting the value
into a string.
Number to string
action

Запись
Rec

Stores a single row of values extracted
from a table. The values can be boolean,
datetime, number, or string.

Переменная записи

Example of entering
data into a web form
from a worksheet

Сеанс
Sess

Stores the session name from the Базовый
Excel, Расширенный Excel, or Эмулятор
терминала пакеты. Pass this variable from
a parent to a child бот in the Task bot
> Run action to enable the child бот to
process the data in the file opened in the
parent бот.

Прим.:  When initializing this variable in
the child бот, select Use as input.

Example of sharing an
Excel session between
bots

Строка
Str

Stores alphanumeric and special
characters, and empty values. It can hold
up to 65535 UTF-8 characters. A string
variable can hold multiple lines of text.

You can compare
the value in a String
variable to an empty
String variable.
Example of using a
conditional statement

Таблица
Table

Stores multiple values in a table of rows
and columns. The values can be boolean,
datetime, number, or string.

Assign values to a
table variable by
extracting values
from a CSV/TXT file,
Excel file, or a Web
form.

Окно
Win

Stores a window title and URL.
When you create a Window type variable,
note that selecting Browser as default
value supports only Google Chrome tabs
whereas selecting Application as default
value supports any application window.

Some actions, such
as the Capture
action, create a
Window variable to
store the specified
window title and
URL.
Example of extracting
data from a web table
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Delete variables

You can delete user-created variables in either of the following ways:
• Delete one variable: In the Variables palette, click the vertical ellipsis to the right of the variable

name and click Delete variable.
• Delete unused variables: In the Variables palette, click Delete unused variables, select which

variables to delete, and click Delete.

Задачи, связанные с данной
Create a variable
Create a variable to store values.
Ссылки, связанные с данной
Boolean пакет
The Boolean пакет contains actions that enable you to do various operations on boolean values.
Таблица данных пакет
The Таблица данных пакет contains actions that enable you to perform various operations on the values
of table variables. Use these actions to join or merge content, search for specific values, insert rows and
columns, remove duplicate rows, and write values to a file.
Datetime пакет
A datetime value consists of a date, time, and time zone. Рабочая область RPA stores datetime values in a
Datetime variable. The Datetime пакет contains actions that enable you to perform various operations on
datetime values. You can use these actions to manipulate and compare values in the Datetime variables.
Dictionary пакет
The Dictionary пакет contains actions that enable you to do various operations on dictionary-type values.
Список пакет
The List пакет contains actions that enable you to perform various operations on a variable of the list data
type.
Число пакет
пакет Число содержит actions, позволяющие выполнять различные операции с числовыми
переменными. В числовых переменных хранятся числовые значения, включая целые и десятичные
числа. В них хранятся значения от -9 223 372 036 854 775 808 до 9 223 372 036 854 775 807 и до 15
десятичных разрядов.
Строка пакет
Use the Строка пакет to perform various operations such as comparing two strings, retrieving the string
length, or converting a string to uppercase or lowercase.
Type conversion
You can temporarily convert the values inside a Boolean, Number, or String variable
from one type to another type (typecasting) to use within one action. For example, use
$<YourStringVariable>.String:toNumber$ to convert the value of a string variable to a number
variable to perform mathematical operations.
Recursive expressions
Use a recursive expression to insert a variable in the place of an index or key of a dictionary, list, record, or
table variable.

Create a variable
Create a variable to store values.
When you create a variable that uses characters such as the underscore (_) or hyphen (-) in your variable
name, note that the underscore or hyphen are treated as the same character for the variable names. For

© 2023 Automation Anywhere. All rights reserved.     2044



    Automation Anywhere - Сборка

example, global-temp_path is treated the same as global_temp-path. If you create a new variable that uses
variables different from these two characters, an error is displayed.
If you have created a global variable as global-temp-path, you can refer to this variable in any of the
following formats:
• global-temp-path
• Global-Temp-Path
• global_temp_path
• Global_Temp_Path

To create and configure a variable, perform the following steps:
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1. From the Bot editor, click Variables > Create variable (+ icon) at the top of the Variables menu.

© 2023 Automation Anywhere. All rights reserved.     2046



    Automation Anywhere - Сборка

2. In the Create variable window, enter a descriptive name for the variable that is prefixed by a
lowercase letter to indicate the variable type.
For example, sCellValue to indicate a string data type.

Прим.:
• You can use double-byte characters, such as Chinese, Japanese, or Korean characters, in a variable

name. Unicode range supported in variables
• Variables cannot be named Java keywords, such as String, Boolean, Integer, Public, and Finally.

3. Необязательно: Введите описание.

Recommendation:  Provide meaningful variable description when defining input or output variables.

4. Необязательно: Select the Constant (read-only) option to ensure values cannot be edited or
overwritten.

5. Выберите один из указанных ниже параметров.
This field pertains to using a бот to run other боты. См. раздел TaskBot пакет.
• Use as input: The variable holds a value that can be passed from the parent бот to a child бот.

(Applicable only to a child бот)
• Use as output: The variable holds a value that can be passed from a child бот to the parent бот.

(Applicable only to a child бот)
• Both: The value can be passed in both directions.
• Neither: The variable is confined to this бот; it cannot be shared across other боты.

The following example illustrates when to select Use as input or Use as output in a variable.
Suppose you want to add two numbers. The values are present in the parent бот, and the child бот
performs the calculations. For the parent бот to transfer the values to the child бот, the two variables
you created must be selected as Use as input so that the child бот can receive the values. Now, for
the parent бот to receive the calculated value, the variable that stores the result of the calculation in
the child бот has to be selected as Use as output.

Прим.:  Ensure that you select the check boxes when you create a variable in the parent бот and the
child бот. When you build the бот, and if you edit the selection of check boxes, it might impact your
parent бот references, such as your parent бот might not work after this change.

6. Select a data type from the drop-down list.
For more information on data types, see Variable types.

7. Необязательно: Enter a default value to assign to the variable.
The values are NULL/empty by default.

8. Click Create.
The variable appears in the Variables pane on the left side of the Bot editor.
If you want to edit a variable, you can change its name and value but not its data type.
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9. To insert a variable into an action field, perform one of the following actions:
• Click F2 to open the variables list.
• Click the Insert a value icon, located on the right side of the field.
• Enter the variable name. As you type, the field generates suggestions of existing variables.

Прим.:  Add a dollar sign at the start and end of the variable. Например, $myVariableName$, .

You can use the variable option and pass it as a parameter to open a file in пакеты such as XML,
Базовый Excel, or Расширенный Excel. To open files with different extensions, use the variable option
to assign the folder path, file name, and file extension . First, create a variable for the folder path,
$sFolder$. Then, for the files in the folder path, create two variables, one for file name $name$ and
another for file extension $extension$. To open a file, combine the variables as a string, such as
$sFolder$\$name$.$extension$. For the extension to work with different file types and different
open options, you can add conditional logic.

Build a Go be Great бот: Follow the steps in this procedure for an example of how to create a variable and
assign it to an action.

Type conversion
You can temporarily convert the values inside a Boolean, Number, or String variable
from one type to another type (typecasting) to use within one action. For example, use
$<YourStringVariable>.String:toNumber$ to convert the value of a string variable to a number
variable to perform mathematical operations.
In the text field, enter $<variable name>.. After you enter the period, the auto-fill suggests possible
actions such as toNumber.

Тип переменной Typecasting options

Логический • invert: Converts the Boolean value to the opposite value (True to False and
False to True).

• toNumber: Converts the Boolean value to a numeric value (True to 1 and
False to 0).

• toString: Converts the Boolean value to a string value.

Число • decrement: Decreases the number value by one.
• increment: Increases the number value by one.
• toString: Converts the number value to a string value.

Прим.:  When you convert a number value to a string value and if the
number has a decimal value, the decimal value is removed after conversion.
For example, 15.234 will be shown as 15 when you convert it.

© 2023 Automation Anywhere. All rights reserved.     2048



    Automation Anywhere - Сборка

Тип переменной Typecasting options

Строка • length: Returns the number of characters in the string as a numeric value.
• lowercase: Converts the characters in the string to lowercase.
• reverse: Reverses the characters in the string.
• toBoolean: Converts the string value to a Boolean value.
• toNumber: Converts the string value to a number value. The limits of the

String to Number action apply here.
See String to number action.

• trim: Trims blanks and whitespaces from the string.
• uppercase: Converts the characters in the string to uppercase.

Прим.:  Type casting is not supported for the following scenarios:
• As a value that is passed between боты.
• As a property value for an object captured with the Universal Recorder.

Свойства объекта

Recursive expressions
Use a recursive expression to insert a variable in the place of an index or key of a dictionary, list, record, or
table variable.
A recursive expression contains a variable nested inside of another variable (the outer variable). The value
of the outer variable is conditional based on the value of the nested variable.
For example, the list variable $listOfPlanets$ has the following values: Mercury, Venus, Earth, Mars,
Jupiter, Saturn, Uranus, and Neptune. The Number variable $indexPosition$ has value of 2. The
expression $listOfPlanets[$indexPosition$]$ returns Earth.
The following types of expressions are supported. You can create a recursive expression containing up to
10 expressions.
• $dictionaryVariable{$key$}$
• $listVariable[$index$]$
• $recordVariable[$index$]$
• $tableVariable[$rowIndex$][$columnIndexOrName$]$

Прим.:
• You cannot use a Table variable within a List variable. For example, the following expression is not

supported: $vListStr[$vTable[0][0]$]
• You cannot combine expressions with properties. For example, the following expression is not

supported: $dictionaryVar{$listStrVar[2]$}.String:reverse$

Переменная записи
A record variable holds a row of data extracted from a database, spreadsheet, or table in name-field pairs.
The fields can store values of Boolean, datetime, number, or string data type.
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Working with a record variable

Record variables are commonly used in the loop action to store a single row of retrieved data; you can
access a single value by specifying the index number or name. The index number is the position of the
name-field pair. The name is either configured when the variable is initialized or it can be extracted from
the column headers of the source table.
The following is an example table:

CustomerName City

Dana Pittsburgh

Сэм Los Angeles

Alex Boston

In this example, a бот loops through the preceding table and assigns each row to rCurrentRow. To
retrieve the value from the first column of each row, use either the index number $rCurrentRow[0]$ or
name $rCurrentRow{CustomerName}$.

Прим.:  To retrieve a date time value from a record variable and use it as a string, concatenate the record
variable with a string value in the action field.

Schema

A schema is like a template for the record fields. It sets the order of the fields and the type of data that
can be entered into each field.
If you select the Set schema option when creating a new record variable, the following conditions apply
at runtime, where the бот retrieves a row of data and stores it to a record variable:
• The retrieved values must match the configured field data types.

For example, the data set [{"name":"Sally"},{"id":002},{"dob":03/05/1989}] can
be assigned to a record variable with the schema [{"name":String},{"id":Number},
{"dob":Date}].

• The data set attributes must follow the same order and capitalization.
For example, the data set [{"name":"Henry"},{"id":003},{"dob":06/13/2001}] cannot
be assigned to a record variable with the schema [{"id":Number},{"name":String},
{"dob":Date}] or {"Name":String},[{"ID":Number},{"DOB":Date}].

• The record variable can accept a superset of the configured fields if the fields are in the same order.
For example, the data set [{"name":"Alex"},{"id":004},{"dob":12/10/1995},
{"pet":"yes"}] can be assigned to a record variable with the schema [{"name":String},
{"id":Number},{"dob":Date}].

• The record variable does not accept a subset of data.
For example, the data set [{"id":005},{"dob":05/21/1975}] cannot be assigned to a record
variable with the schema [{"name":String},{"id":Number},{"dob":Date}].

If the бот encounters a row of data that does not meet the record variable schema, the бот fails. This
prevents the бот from passing incorrect or invalid data into the next action.

Unicode range supported in variables
Review the valid characters that can be used in a variable name.
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Язык Characters Диапазон

Арабский U+0600 - U+0605, U+0620 - U
+0669, U+066E - U+06D3

Общий U+4E00 - U+9FEA

Extension A U+3400 - U+4DB5

CJK ideographs

CJK compatibility ideographs U+F900 - U+FA6D

Chinese Chinese Kanji See CJK ideographs

Greek All alphabetical characters
(uppercase and lowercase)
are supported. For extended
characters ( ά έ ή ί ϊ ΐ ό ύ ϋ ΰ ώ
€)

U+0370 - U+0374,
U+0376 - U+0377,
U+037A - U+037D,
U+037F - U+0386,
U+0388 - U+038A,
U+038C, U+038E - U+03A1, U
+03A3 - U+03F5,
U+03F7 - U+03FF,
U+1F00 - U+1F15,
U+1F18 - U+1F1D,
U+1F20 - U+1F45,
U+1F48 - U+1F4D,
U+1F50 - U+1F57, U+1F59, U
+1F5B, U+1F5D,
U+1F5F - U+1F7D,
U+1F80 - U+1FB4,
U+1FB6 - U+1FBC, U+1FBE,
U+1FC2 - U+1FC4,
U+1FC6 - U+1FCC,
U+1FD0 - U+1FD3,
U+1FD6 - U+1FDB,
U+1FE0 - U+1FEC,
U+1FF2 - U+1FF4,
U+1FF6 - U+1FFC

Hiragana U+3041 - U+3096,
U+309D, U+309E

Katakana
full-width and half-width
characters

U+30A1 - U+30FA, U+30FC

Японский

Kanji See CJK ideographs
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Язык Characters Диапазон

Double-byte numbers U+FF10 - U+FF19

Корейский Hangul Syllables U+AC00 - U+D7A3

Latin a-z
A-Z

U+0061 - U+007A
U+0041 - U+005A

Latin-1 supplement U+00C0 - U+00D6,
U+00D8 - U+00F6,
U+00F8 - U+00FF

Latin Extended-A U+0100 - U+017F

Latin Extended-B U+0180 - U+024F

Latin Extended-C U+2C60 - U+2C7F

Latin extended
(Czech, Danish, Dutch, Finnish,
French, German, Hungarian,
Italian, Norwegian, Polish,
Portuguese, Romanian, Spanish,
and Swedish)

Currency symbols U+20AC

Числа 0-9 U+0030 - U+0039

Russian Cyrillic U+0400 - U+0481,
U+0483 - U+0487,
U+048A - U+04FF

Специальные символы Hyphen (-) and underscore (_) U+002D, U+005F

Use Work Item variables
You can use the Work Item variables to pass the Work Item attributes or values to the TaskBot from the
Control Room when you run the бот with the option Run bot with queue.
The Work Item variables are available in a TaskBot only after you attach a work item template to the
TaskBot when you define the work item template in the work item structure during queue creation.
Attach work item template to TaskBot

1. На левой панели щелкните Автоматизация.
Отобразится список доступных  и форм.

2. Щелкните Создать бота.
3. In the Create a Taskbot window, enter the required parameters such as Name, Description, and

Folder location.
4. Click Create & edit to open the TaskBot in edit mode.
5. Attach the бот to a queue category by selecting a Work item template.

Attach work item template to TaskBot
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6. Press the function key F2 to open the Insert a variable window and add the following Workload
variables to an action:
a) workItem to view the default values or attributes of the Work Item when you run the TaskBot

using the Run bot with queue option.
The workItem is an input variable for debugging a Workload бот to be used for TaskBot
deployment options Run now and Schedule a bot. You can add the values for the workItem
variable when you create an automation.
On the other hand, when you use the option Run bot with queue, the workItem variable uses
the values passed on by the Control Room.

b) workItemResult to set the final outcome of the Work Item when you run the TaskBot using the
Run bot with queue option.
Use the String > Assign actionto set the value of workItemResult variable. This is an output
variable type and you can use the string values as well as other variables to set the value of
workItemResult variables.

The variables are read-only and therefore cannot be edited or deleted from the TaskBot editor page.
Double click a variable in the Variables panel to view the variable parameters:
• Variable name.
• Description of the variable.
• Read only if the Constant check box is selected when the variable was created.
• To be used as input or output parameter in a TaskBot during run time.
• Variable type.
• The default values or attributes that are configured with the Work Item template for a workItem

variable or the default output values for a workItemResult variable.

Понятия, связанные с данным
Управление рабочей нагрузкой
Модуль управления рабочими нагрузками позволяет пользователям загружать файлы Microsoft Excel
и CSV в Control Room, чтобы записи из этих файлов попадали в развертывания бот.
Задачи, связанные с данной
Define Work Item structure
Define the Work Item structure for processing in a queue. This enables you to manually upload the Work
Items from the system in the absence of ready data in a file.
Attach work item template to TaskBot
Attach a work item template to a TaskBot to use the TaskBot in workload automation.
Ссылки, связанные с данной
Рабочая нагрузка пакет
The Рабочая нагрузка пакет enables you to insert work items in a queue for workload automation. It also
enables data chaining between multiple queues. You can orchestrate multiple боты, and enable optimal
device utilization through the queueing mechanism of workload management.

Credentials and credential variables in the Bot editor
Use credentials when building боты to pass sensitive information such as passwords and account numbers.
Using credentials separates the sensitive information from the боты and Bot Runner, which reduces the
risk of data spillage or unauthorized user access.

Credential A credential holds the sensitive information in
attributes. An attribute can have a value that is
standard for all users or it can accept a user-input
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value. For example, an Email credential can hold
three attributes: host name (standard value),
username (user input), and password (user
input).
Credentials are predefined in the CREDENTIALS
tab and cannot be modified when the user is
building or running a бот.
По умолчанию все пользователи могут
создавать, использовать собственные учетные
данные, а также управлять ими. A user is granted
access to another user's credentials by receiving
access to a ячейка that holds the credential. If the
credential requires a user-input value, it appears in
the CREDENTIAL REQUESTS tab.
A credential must be assigned to a ячейка to be
used for building and running a бот.

Ячейка A locker specifies which users can view, modify,
or access the credentials. For example, a human
resources (HR) locker can hold Email, Database,
and Training website credentials and allow
only specific employees of the HR department to
use the credentials in their боты.

Credential variable A credential variable stores a credential value in a
user-defined variable. It enables users to securely
pass values to a бот and from a бот to another бот.
Using a credential variable ensures that the values
are not displayed in a message box or written to a
file. The value is either selected from the Credential
Vault or is provided by the user. You can use it into
any action field that accepts a variable.

Прим.:  Values of this data type cannot be
converted to another data type.

You can:
• Pass login credentials to a child бот.
• Retrieve confidential data, such as account

numbers, and pass them to the main бот.

Прим.:  You cannot pass credential values to the
main бот when you deploy it from the Run bot
now page. The values must be hard-coded in the
бот or selected from the Credential Vault.

Working with credentials

• Only fields with a Credential tab below the field name accept a credential.
• Действие fields display the ячейка, credential, and attribute name; users can not see attribute values

in the Bot editor.
• A credential cannot be appended to other variables or to a string.

© 2023 Automation Anywhere. All rights reserved.     2054



    Automation Anywhere - Сборка

Задачи, связанные с данной
Создать учетные данные
Create a credential and add the required attributes.
Edit a credential
Modify credential details and add or remove attributes.

Example of building a бот that uses credentials
Build a бот that securely logs in to an online bank using credentials from Credential Vault, ensuring that
the username or password is not stored in the бот or on the device.
• Credentials must be assigned to a ячейка to be used in a бот.
• You must have Consumer permissions to the ячейка.

If the email notification setting is enabled, you receive an email that confirms the ячейка name and
your permissions to that ячейка.

In this example, you configure a credential with user-provided values and build a бот to automate logging
into an online bank website.
1. Provide the user-input values.

a) Navigate to BOTS > Credentials > CREDENTIAL REQUESTS.
The credentials that require a user-provided value have an incomplete icon in the first column.

b) Click the credential that holds the bank login credentials.
c) Click Edit.
d) Enter the attribute values for the username and password and click Save changes.

2. Откройте нового бот.
a) На левой панели щелкните Автоматизация.

Отобразится список доступных боты и форм.
b) Щелкните Создать > Бот.
c) Enter a бот name and click Create and edit.

3. Open the browser to the bank login page.
a) Double-click or drag the Browser > Open action.
b) Enter the URL.

For example, www.examplebank.com/login.
Use an application page where you want to enter a credential.

c) Select your preferred browser.
d) Click Save and Run.

The bank website opens in a new window. If the website opens in a new tab, drag it into a
separate window.

4. Specify the username text box.
a) Double-click or drag the Recorder > Capture action.
b) From the Object detail menu, select the window containing the bank website.
c) Click Capture object.

The window containing the bank website is activated.
d) Hover over the username text box and click when a red outline appears.
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e) In the Object properties table, verify that the Control Type is a textbox.
f) From the Action menu, select Set text.
g) Select the Select a credential option and click Pick to navigate to the credential.

The Pick a credential window appears.
h) Select the Locker, Credential, and Attribute for the bank website username and click

Confirm.

5. Repeat Step 4 to specify the password text box.
6. Specify the Log on button.

a) Double-click or drag the Recorder > Capture action.
b) From the Object detail menu, select the window containing the bank website.
c) Click Capture object.

The window containing the bank website is activated.
d) Hover over the Log on button and click when a red outline appears.
e) In the Object properties table, verify that the Control Type is a button.
f) From the Action menu, select Click.

7. Close the window containing the bank website.
8. Click Save and Run.

Example of building a бот that uses credential variables

Perform the steps in this task to learn how to pass values securely between боты.
Ссылки, связанные с данной
Пакет Средство записи
Средство записи пакет захватывает серию задач в ходе их выполнения, а затем автоматизирует
их. Вы можете автоматизировать работу своих бизнес-приложений (например, настольных и
веб-приложений, приложений SAP и Java) с помощью функции Средство записи для записи
actions, выполняемых с объектами приложений, например с текстовым полем, кнопкой, таблицей,
переключателем, комбинированным полем и представлением списка.
Credentials and credential variables in the Bot editor
Use credentials when building боты to pass sensitive information such as passwords and account numbers.
Using credentials separates the sensitive information from the боты and Bot Runner, which reduces the
risk of data spillage or unauthorized user access.

Example of building a бот that uses credential variables
Securely pass values to a бот using credential variables to automate the process of logging in to a bank
website.
Complete the steps in the following task to build the child бот that automates logging in to a bank website:
Example of building a бот that uses credentials

Эта задача выполняется пользователем, который хочет создать и развернуть . Для выполнения этой
задачи вы должны обладать необходимыми правами и разрешениями, а также вам должен быть
разрешен доступ в  в качестве лицензированного пользователя.
In this example, you modify the бот to accept credentials passed from a parent бот.
In the бот that you built for Example of building a бот that uses credentials, create two credential variables
and insert them into the Recorder > Capture actions.
1. Configure the credential variable to hold the username.
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Поле Ввод

Имя имя пользователя

Использовать как вход Выбрать

Тип Credential

Значение по умолчанию Insecure string, leave field empty

2. Configure the credential variable to hold the password.
Поле Ввод

Имя пароль

Использовать как вход Выбрать

Тип Credential

Значение по умолчанию Insecure string, leave field empty

3. Modify the first Recorder > Capture action.
a) Click the action to open it in the action editor.
b) In the Select a credential field, select the Variable tab.
c) Click F2 to open the Variables menu and select $username$.
d) Click Yes, insert.

4. Repeat the substeps in step 3 to insert the $password$ variable into the second Recorder >
Capture.

5. Click Save and Close
The Automation page appears.

Create a parent бот that will run the child бот and pass it the credential values.
6. Откройте нового бот.

a) Щелкните Создать > Бот.
b) Enter a бот name and click Create and edit.

7. Insert a Task Bot > Run action to select the бот and provide the login credentials.
a) Double-click or drag the Task Bot > Run action.
b) In the Task Bot to run field, select the Control Room file tab.
c) Click Browse and select the бот that you modified in the above steps.
d) In the Input values options, select both Set username and Set password.
e) For each credential variable, click Pick to select the locker, credential, and attribute.

8. Click Save and Run.

Задачи, связанные с данной
Create a variable
Create a variable to store values.
Ссылки, связанные с данной
TaskBot пакет
Use the Run, Pause, and Stop actions in the TaskBot пакет to manage running one or more child боты
from a parent бот or with a third-party software using an API.
Credentials and credential variables in the Bot editor

© 2023 Automation Anywhere. All rights reserved.     2057



    Automation Anywhere - Сборка

Use credentials when building боты to pass sensitive information such as passwords and account numbers.
Using credentials separates the sensitive information from the боты and Bot Runner, which reduces the
risk of data spillage or unauthorized user access.

Глобальные значения
Global values enable users to reuse identical values between боты instead of creating new variables for
each бот. A user with the AAE_admin role configures a global value with a default value and can enable
non-admin users to overwrite the value to use in their боты.

Data types

Тип данных Описание

Дата/время Stores a value containing a single date and time value.

Число Stores numeric values, including integers and decimals. It can hold up
to 15 decimal digits.

Строка Stores alphanumeric and character values.

Логический Stores a Boolean value as True or False, default value is False.

Working with global values

Прим.:  The maximum number of public global values that can be created by an admin user is 150.

Users can perform the following tasks:
• Create a global value as an admin.

Создание глобального значения
• Update the default value as a non-admin.

Overwrite the default value
• Delete a global value.

A user with the AAE_Администрирование role can delete a global value by hovering over the
vertical ellipsis to the right of the value, and clicking the Delete icon. When a global value is deleted,
any overridden values for that global value are also deleted.

• Insert global values into боты.
All action fields that accept a user-created variable accept a global value. Insert a global value into an
action field by pressing F2 or by clicking the Insert a value icon on the left side of the field.

Создание глобального значения
Чтобы создать глобальное значение, настроить тип данных, установить значение по умолчанию и
разрешить обновление значения пользователям, не являющимся администраторами, вы должны
обладать функцией AAE_Admin
1. Войдите в систему как администратор и перейдите в раздел Управление > Глобальные

значения.
Откроется страница Все глобальные значения с таблицей глобальных значений.

2. Щелкните Создать глобальное значение.
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Появится экран Создать глобальные значения.
3. Введите описательное имя длиной до 50 символов.

Прим.:
• Когда глобальное значение инициализировано, изменить имя невозможно.
• Глобальным значениям нельзя в качестве имен присваивать ключевые слова Java, такие как

String, Boolean, Integer, Public и Finally.

4. Необязательно: Введите описание длиной до 255 символов.
5. Выберите тип данных в раскрывающемся списке.

Data types

6. Введите значение по умолчанию.

Прим.:  Когда значение инициализировано, изменить тип невозможно.

7. Укажите, могут ли пользователи заменять значение:
• НЕ МОЖЕТ быть изменено: Значение по умолчанию остается постоянным для всех

пользователей и боты.
• МОЖЕТ быть изменено: Пользователи могут заменить значение по умолчанию, чтобы

использовать его в своих боты.

Прим.:  Если при создании глобального значения вы установили для его области параметр НЕ
МОЖЕТ быть изменено, то позже вы не сможете изменить параметр области на МОЖЕТ
быть изменено. Если вы хотите задать для области глобального значения параметр МОЖЕТ
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быть изменено, удалите значение и создайте его заново, задав для его области параметр
МОЖЕТ быть изменено.

8. Щелкните Создать глобальное значение.

Overwrite the default value
Global values can be configured to allow non-admin users to overwrite the default value. When building
боты, use a global value for values that remain constant across all боты instead of creating a new variable
for every бот.
As a non-admin user, you can only overwrite the default value in global values with a changeable scope.
You can identify which global values have a changeable scope by checking the value in the Scope
changeable column in the All global values table.
To verify if a global value has a changeable scope and to overwrite the default value, do the following
steps:
1. Navigate to BOTS > Global values.

The All global values table appears. Each row shows the data type, value name, whether the scope
is changeable, and the last modified date and time.

2. Find the global value that has a changeable scope.
3. Move your mouse over the vertical ellipsis and click Edit global value.

The Edit global value page appears with the User value field enabled.
4. Enter the value that will overwrite the default value.

Прим.:  This value will overwrite the default value of this global value in all of your боты.

5. Щелкните Сохранить изменения.

Бот dependencies
Боты dependencies are files and other боты that are required to run that бот successfully.
Задачи, связанные с данной
Upload бот and its dependencies
You can upload Enterprise 11 or Enterprise 10 боты, their dependent боты, and other files that are
required to run a бот successfully in the Automation 360 Control Room.
View боты dependencies
You can view the files and боты that are added to a бот as its dependencies.
Ссылки, связанные с данной
Бот dependencies
Боты dependencies are files and other боты that are required to run that бот successfully.

Upload бот and its dependencies
You can upload Enterprise 11 or Enterprise 10 боты, their dependent боты, and other files that are
required to run a бот successfully in the Automation 360 Control Room.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. In the PRIVATE tab, expand the Bots folder and select the folder in which you want to upload the

dependent files.
3. Click the Upload files icon.
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4. On the Upload files page, click Add files.
5. From the Open dialog box, select the files you want to upload and click Open.
6. Click Upload.

Задачи, связанные с данной
Add бот dependencies
You must add the files that are required to run a бот as its dependencies.
View боты dependencies
You can view the files and боты that are added to a бот as its dependencies.

Add бот dependencies
You must add the files that are required to run a бот as its dependencies.
Ensure that the files you want to add as dependencies are uploaded in the Control Room, except for боты.
The system identifies the automatic dependencies for a бот and adds the required files and other боты
as its dependencies. However, for manual dependencies, you must identify the files and боты that are
required and add them as dependencies for a бот.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. In the PRIVATE tab, expand the Bots folder that contains the бот for which you want to add

dependencies.
3. Select the бот for which you want to add dependencies.
4. Select the Edit Task Bot icon from the actions menu (vertical ellipsis) on the right.
5. Select Dependencies from the actions menu (vertical ellipsis) on the top-right.
6. Expand the Bots folder and select the folder that contains the files you want to add as dependencies.
7. Select the files you want to add as dependencies from the Available files section and click the right

arrow.
8. Щелкните Сохранить.
9. Click Return to editor if you want to update the бот or click Close to close the бот.

Задачи, связанные с данной
View боты dependencies
You can view the files and боты that are added to a бот as its dependencies.
Upload бот and its dependencies
You can upload Enterprise 11 or Enterprise 10 боты, their dependent боты, and other files that are
required to run a бот successfully in the Automation 360 Control Room.

View боты dependencies
You can view the files and боты that are added to a бот as its dependencies.
1. In the PRIVATE or PUBLIC tab, expand the folder that contains the бот for which you want to view

dependencies.
2. Select the бот for which you want to view dependencies.
3. Select the View Task Bot icon from the actions menu (vertical ellipsis) on the right.
4. Select Dependencies from the actions menu (vertical ellipsis) on the top-right.

The system shows a list of files and боты that are added as dependencies for the бот.
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Задачи, связанные с данной
Add бот dependencies
You must add the files that are required to run a бот as its dependencies.
Upload бот and its dependencies
You can upload Enterprise 11 or Enterprise 10 боты, their dependent боты, and other files that are
required to run a бот successfully in the Automation 360 Control Room.

Edit бот-dependent text-based files
As a Bot Creator, you can open, view, edit, and save бот-dependent text-based files directly inside the
workbench. Automation 360 supports more than 40 text-based file formats, such as TXT, XML, JSON, and
Javascript.
• У вас должна быть лицензия Bot Creator.
• You must be assigned a custom role, with the View content and Check out permissions assigned at

the folder level.

If you have the Check in permission, you can check in the edited files to the public workspace.
1. Log in to the Control Room as Bot Creator.
2. In the Private page, expand the Bots folder and select the folder that contains the бот-dependent

text-based files that are added as dependencies.

Прим.:  You can edit only the text-based dependent files.

3. Select the file that you want to edit.
4. From the actions menu (vertical ellipses) on the right, click Edit file to open the file in the text editor.

The file opens up with all the formatting effects.
For example, XML files open up with the same formatting as that in code editor, providing you with a
similar experience.

5. Make changes to the file and click Save.
The changes made to the file are saved.

6. Щелкните Закрыть.

Check out non-бот file dependencies
Check out the specific versions of the non-бот file dependencies from the public workspace to the private
workspace to create an editable copy of the file.
Ensure you have completed all the prequisites for checking out non-бот file dependencies: Prerequisites for
checking out бот and dependencies.
1. Войдите в Control Room как пользователь Bot Creator или Непрофессиональный разработчик.
2. На левой панели щелкните Автоматизация.

A list of available боты, forms, and non-бот files are displayed.
3. You can choose to check out either one file or multiple files simultaneously.

• Select the file dependency that you want to check out, click the actions menu (vertical ellipsis), and
click Check out file.

• Select the file dependencies that you want to check out and click Check out checked items.

Вариант Шаги

Выгрузить файл Select this option to check out the latest version of the dependent file.
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Вариант Шаги

Расширенные
параметры

Select this option to select a specific version of the dependent file to check
out.
a. Click Advanced optoins.
b. Select the version of the dependent file to check out.
c. Add or remove further dependencies if any.
d. Select the version of these dependencies.
e. Review the dependencies (Overwritten, Missing, Cloned,

Skipped.)
f. Щелкните Выгрузить.

The file appears in the same folder structure in the private workspace.
4. To cancel the checked-out dependent file, click the Cancel check out for file option.

Этот параметр можно использовать как в общедоступной, так и в личной рабочей области.
In the public workspace, the file status changes to Public, and the file is available for check out by
another user with the appropriate permissions. In the private workspace, the file status changes to
New if any changes were made to the file. If there are no changes, the file is replaced with a clone.

View version history of non-бот file dependencies
You can now view the version history of your non-бот file dependencies such as TXT, XML, JSON, XLS,
VBS, CSV, Javascript files, to identify relevant changes performed by other users to your files on a specific
date and time along with the check-in messages.
You must have check-in and check-out permissions.
You can view the version history of the non-бот file dependencies available in the public workspace and
the private workspace (only if there are checked-out files). However, there is no version history available
for new and cloned files.
1. Войдите в Control Room.
2. На левой панели щелкните Автоматизация.

A list of боты, forms, and dependencies are displayed.
3. Select the dependency file for which you want to view the version history. Hover over the actions

menu (vertical ellipsis) on the right and click View history file.
A message appears listing all the versions of the selected file in a sequence (latest revision on the top
and first revision at the bottom). The information includes the version number, check-in message, date
and time of check-in, and the username that made the check-in.

Get started building боты
Use the following three examples to become familiar with building боты using in the cloud-based Bot
editor. These examples demonstrate using actions and the Universal Recorder to automate tasks in
applications and browsers.

Build a Go be Great бот Build a basic бот using a Message Box action and
a variable. Follow these steps to create your first
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бот that prints the message, Go be great!, the
Automation Anywhere version of Hello World!

Build a basic бот that uses a desktop application Build a бот that uses a conditional statement
to verify that the calculator is open, then uses
the calculator to multiply two numbers. This
example uses actions from the Приложение, Если,
Имитация нажатия клавиш, Message Box, and
Окно пакеты.

Example of extracting data from a web table Build a бот to open a browser window to the
Wikipedia website, extract the data from a table,
and write it to a CSV file on your desktop. This
example uses actions from the Браузер, Таблица
данных, Средство записи, and Окно пакеты.

For more examples, see Examples of building боты.

More resources

• To learn more, search for the Hello Automation 360 Bot: Getting Started with Building Bots course in
Automation Anywhere University: RPA Training and Certification (A-People login required).

• You can also visit the Learn section of the developer portal for more guidance. Find learning journeys and
videos for both new and experienced developers on how to build your first боты.

Build a Go be Great бот
Build a basic бот using a Message Box action and a variable. Follow these steps to create your first бот
that prints the message, Go be great!, the Automation Anywhere version of Hello World!
To build a бот you must already have done the following:
• Установка Bot Agent и регистрация устройств
• Set user device credentials

If you have already completed the steps in Создание первого бот, skip to Step 6.
1. Create a new бот:

a) На левой панели щелкните Автоматизация.
b) Щелкните Создать > Бот.
c) In the Create Task Bot window, enter the бот name.
d) Accept the default folder location: \Bots\

To change the default бот storage location, click Choose and follow the prompts.
e) Щелкните Создать и редактировать.
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2. Вставьте action Окно сообщения.
a) Щелкните Действия.
b) Search for the Message Box пакет.

Щелкните по полю поиска Действия и введите сообщение. Щелкните по стрелке, чтобы
развернуть параметры Message Box.

c) Дважды щелкните или перетащите action Окно сообщения в Bot editor (открытая область
справа).

3. В диалоговом окне справа укажите условия для action Окно сообщения.
a) В поле Введите заголовок окна сообщения введите My first bot!.
b) В поле Введите сообщение, которое требуется отобразить введите Go be great!
c) Примите значения по умолчанию в поле Полоса прокрутки после строк и установите

флажок Закрыть окно сообщения после.

4. Щелкните Сохранить.
Ваш бот готов к работе.
Время, потраченное на создание бот, можно просмотреть в разделе Автоматизация >
Главная страница > Мои измерения. В таблице Активные Task Bot отображается время,
потраченное на создание каждого бот. Когда бот редактируется, в таблице отображается общее
время, потраченное на бот.
Например, если вы потратите 10 минут на создание и сохранение бот, то в таблице Активные
Task Bot для потраченного времени будет отображаться 10 минут. Если вы потратите еще
5 минут на редактирование того же бот, то в таблице Активные Task Bot для общего
потраченного времени будет отображаться 15 минут.
Аналогично, в поле Среднее время, потраченное на создание Task Bot на странице Мои
измерения отображается среднее время, потраченное всеми пользователями на создание всех
боты.
For example, if user 1 spends 120 minutes on Bot A, user 2 spends 2 minutes on Bot B, and user 3
spends 4 minutes on Bot C, the average time is calculated as (120+2+4)/3 = 42 minutes.

5. Test your бот.
Click Run at the top right.
The бот displays a Message box with the text Go be great!.

In the following steps, you configure a variable and insert it in the Message box.
6. Create a variable.

a) Click Variables from the accordion menu on the left panel.
b) Click Create variable (the + sign).
c) Enter vHelloWorld in the name field.
d) Select the Use as output option.
e) Enter Say Go be Great! with a variable in the Default value field.
f) Click Create.
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7. Assign the vHelloWorld variable to the Enter the message to display field.
a) Click the Message box action in the Bot editor.
b) In the dialog box, delete the text from the Enter the message to display field.
c) Either press the F2 key or click the Insert variable icon.

The Insert variable icon is located on the right-side of the text field.
d) Select vHelloWorld from the drop-down list.
e) Click Yes, insert.

8. Щелкните Сохранить.
9. Click Run.

The бот displays a Message box with the text Say Go be Great! with a variable.

After you successfully run your бот, go to Build a basic бот that uses a desktop application.

Build a basic бот that uses a desktop application
Build a бот that uses a conditional statement to verify that the calculator is open, then uses the calculator
to multiply two numbers. This example uses actions from the Приложение, Если, Имитация нажатия
клавиш, Message Box, and Окно пакеты.
To build a бот you must already have done the following:
• Установка Bot Agent и регистрация устройств
• Set user device credentials

1. Откройте нового бот.
a) На левой панели щелкните Автоматизация.

Отобразится список доступных боты и форм.
b) Щелкните Создать > Бот.
c) Enter a бот name and click Create and edit.

2. Insert an conditional sequence that verifies that the calculator is open and activates the window.
a) Double-click or drag the If action.
b) Select Window exists from the Condition drop-down list.
c) Select the Application tab and click the refresh icon to display all open applications.
d) Select Calculator from the Window drop-down list.

The Calculator window is saved to the variable window-1.
e) Drag the Message box action into the If container.
f) In the Enter the message to display field, enter The calculator is running.
g) Drag the Window > Activate action into the If container below the Message box action.
h) In the Window field, insert the window-1 variable.
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3. Insert an alternative sequence that opens the calculator.
a) Double-click the If > Else action.
b) Drag the Message box action into the Else container.
c) In the Enter the message to display field, enter The calculator is not running.
d) Drag the Application > Open program/file action into the If container below the Message

box action.
e) In the Location of the program/file field, enter C:\Windows\System32\calc.exe.

4. Insert the Simulate keystrokes action to perform the calculation.
a) Drag the Simulate keystrokes action below the If and Else containers.
b) In the Window field, insert the window-1 variable.
c) In the Keystrokes field, enter 5*5=.
d) In the Delay field, enter 500.

5. Click Save to save the бот.
6. Run the бот.

When the бот runs, the The calculator is not running message appears, then the Calculator
window opens, and the calculation is performed.

7. Run the бот again.
When the бот runs, the The calculator is running message appears, then the Calculator
window activates, and the calculation is performed.

If the бот does not input all of the numbers into the calculator, try increasing the keystrokes delay.

Example of extracting data from a web table
Build a бот to open a browser window to the Wikipedia website, extract the data from a table, and write it
to a CSV file on your desktop. This example uses actions from the Браузер, Таблица данных, Средство
записи, and Окно пакеты.
To extract data from a table, do the following steps:
1. Create a new бот:

a) На левой панели щелкните Автоматизация.
b) Щелкните Создать > Бот.
c) In the Create Task Bot window, enter the бот name.
d) Accept the default folder location: \Bots\

To change the default бот storage location, click Choose and follow the prompts.
e) Щелкните Создать и редактировать.

For information about бот naming conventions, see Создание первого бот.
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2. Open a browser window to the web page from which you will extract the table.
a) Double-click or drag the Browser > Open action.
b) Select your preferred browser.
c) In the Link to open field, enter https://en.wikipedia.org/wiki/

Table_(information).
d) Щелкните Сохранить.
e) Click Run.

The бот opens the window.

3. Specify the table.
a) Double-click or drag the Recorder > Capture action.
b) From the far-right panel, in the Window options, select the Browser tab and then select the

Table (information) - Wikipedia window from the drop-down list.
If the window title does not appear in the list, click Refresh.

c) Click Capture object.
The Table (information) - Wikipedia window activates.

d) Hover over the Age table below the Basic description heading.
An orange box appears, surrounding the table.

e) Click the table.
The Object Processing message box appears.

f) Return to the Control Room.
g) In the Object properties table, verify the Control Type is TABLE.

If it is not, click Recapture object.
h) From the Action to take on object drop-down list, select Get table.
i) In the Save the outcome to a variable field, create the Tabledata variable.

The Table (information) - Wikipedia window is saved as the variable window-1.
4. Specify the file where to save the data.

a) Double-click or drag the Data Table > Write to file action.
b) From the Data table name list, select Tabledata.
c) Provide a file path to create a CSV file.

For example, C:\Users\<username>\Desktop\WikipediaTable.csv.
d) Select the Create folders/files if it doesn't exist option.
e) Select to overwrite the existing file.

5. Close the Table (information) - Wikipedia window.
a) Double-click or drag the Window > Close action.
b) Select the Variable tab and insert window-1.

6. Щелкните Сохранить.
7. Click Run.

The бот creates a CSV file on the desktop with data on seven indexes, their values, and net change.
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Examples of building боты
Use these example tasks to become familiar with the features and learn to build боты in Automation 360.

Example of entering data into a web form from a worksheet
In this example, you build a бот to enter multiple rows of data from an XLSX sheet into a web form. Use
actions from the Расширенный Excel, Цикл, and Средство записи пакеты.
Before you start building the бот, you can create the following data sets on your desktop in .xlsx format
as below.

Employee name Age Claim amount Claim date Claim type

Mike 30 469 22/3/2022 Медицинские

Sarah 34 766 28/3/2022 Dental

Chris 41 428 13/05/2022 Медицинские

Samantha 45 1000 2022-9-05 Медицинские

To retrieve values from an Excel file and input them into a web form, do the following:
1. Create a new бот:

a) На левой панели щелкните Автоматизация.
b) Щелкните Создать > Бот.
c) In the Create Task Bot window, enter the бот name.
d) Accept the default folder location: \Bots\

To change the default бот storage location, click Choose and follow the prompts.
e) Щелкните Создать и редактировать.

2. Откройте файл Excel.
a) Double-click or drag the Excel advanced > Open action.
b) Введите имя сеанса.
c) Select the Excel file.
d) Отметьте параметр Лист содержит заголовок.

Отмечая параметр Лист содержит заголовок, вы позволяете бот выполнять поиск столбца по
имени заголовка во время выполнения.

3. Launch the website.
a) Double-click or drag the Browser > Open action.
b) Enter the website URL which consists the webform to update the data.
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4. Retrieve the worksheet values and store them in a Table variable.
a) Double-click or drag the Excel advanced > Get multiple cells action.
b) Enter the same session name you used in the Excel advanced > Open action.
c) Select All rows from the drop-down list.
d) Create a Table variable using the icon to the right of the Assign to variable drop-down list.

5. Instruct the бот to process the data row by row.
a) Double-click or drag the Loop action.
b) Select the For each row in table iterator.
c) Select the same Table variable that you used in Get multiple cells.
d) Create a Record variable using the icon to the right of the Assign to variable drop-down list.

The Record variable holds all of the values for one row. With each iteration of the Loop, the бот
retrieves the values of the next row and stores them in the Record variable, overwriting the values
from the previous row.

6. Map the first column header to the web form textbox.
a) Double-click or drag the Recorder > Capture action.
b) Select the same window you opened with the Open action.
c) Click Capture object.
d) Hover over the textbox until a red outline appears.
e) Click the textbox.
f) Return to the Control Room.
g) Verify that the Control Type value is TEXTBOX.
h) Select Set text from the Action drop-down list.
i) In the Keystrokes field, insert the same Record variable that you used in the Loop.
j) Select the By name option and copy-paste the first column header into the field.

7. Repeat the sub-steps in step 5 to map the other columns, with the following differences:
a) Instead of searching for the browser window title, insert the Window variable generated by the

Recorder.
b) When inserting the Record variable in the Keystrokes field, copy-paste the subsequent column

header into the "By name" field.

8. Capture the Submit button.
a) Double-click or drag the Recorder > Capture action.
b) Insert the Window variable generated by the Recorder.
c) Click Capture object.
d) Verify that the Control Type value is BUTTON.
e) Select the Click action.

9. Щелкните Сохранить.

Ссылки, связанные с данной
Расширенный Excel пакет
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The Расширенный Excel пакет contains actions that enable you to automate many of the repetitive tasks
when working with Microsoft Excel spreadsheets.
Цикл пакет
Use the Цикл package to run a sequence of actions repeatedly for a specific number of times or until a
specific condition is met.
Пакет Средство записи
Средство записи пакет захватывает серию задач в ходе их выполнения, а затем автоматизирует
их. Вы можете автоматизировать работу своих бизнес-приложений (например, настольных и
веб-приложений, приложений SAP и Java) с помощью функции Средство записи для записи
actions, выполняемых с объектами приложений, например с текстовым полем, кнопкой, таблицей,
переключателем, комбинированным полем и представлением списка.

Example of passing a value between боты
Learn how to pass a value from one TaskBot to another by using a dictionary variable.
Build a parent TaskBot and a child TaskBot that do the following:
• The parent бот prompts the user to enter a song title and passes it to the child бот.
• The child бот takes the input string and returns a new string to the parent бот.
• The parent бот receives the string that the child бот passes as a dictionary.

1. Build a child бот.
a) From the Control Room interface, select Bots > My bots.
b) Click Create New > Bot.
c) Enter the name for the бот as GetSongDetails.
d) Щелкните Создать и редактировать.

2. Create a variable named sMySong.
a) In the Variables panel, click the Create variable button.
b) In Type, select String if it is not already selected.
c) In Name, enter sMySong.
d) Select the Use as input and Use as output check boxes.
e) Click Create.

3. To build a return string, use the String > Assign action.
a) From the Actions panel, find the String > Assign action, and add it to the child бот flow.
b) In Select the source string variable(s)/ value, enter I love $sMySong$ too!.

During runtime, $sMySong$ in the output string will be replaced with the value that the parent
бот passes to the child бот.

c) In Select the destination string variable, select sMySong to store the new string.
d) Щелкните Сохранить.
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4. Build the parent бот.
a) На левой панели щелкните Автоматизация.

Отобразится список доступных ботов и форм.
b) Click Create New > Bot.
c) Enter the name for the бот as FavoriteSong-Parent
d) Щелкните Создать и редактировать.

5. Create a variable named sMySong.
6. Use the Prompt > For value action to capture a song title.

a) From the Actions panel, find and add the Prompt > for value action to the parent бот flow.
b) In the Prompt window caption field, enter Favorite Song.
c) In the Prompt message field, enter Type the title of your favorite song.
d) In the Assign the value to a variable field, enter sMySong.
e) Щелкните Сохранить.

7. Use the Task Bot > Run action to call the child бот:
a) From the Actions panel, find and add the Task Bot > Run action to the parent бот flow.
b) In Task Bot to run, select Control Room and then click Choose.
c) Click Browse and navigate to the folder that contains the child бот and select

GetSongDetails.
d) In Input values, select Set sMySong and then enter $sMySong$ in the variable field.
e) In Save the outcome to a variable (option), select Dictionary and then create a variable

named dOutput.
f) Щелкните Сохранить.

8. Use the Message box action to display the string that the child бот returns.
a) From the Actions panel, find and add the Message box > Message box action to the parent

бот flow.
b) In Enter the message box window title, enter Automation Anywhere Enterprise

 Client.
c) In Enter the message to display, enter $dOutput{sMySong}$.

The name of the output variable that the child bot uses is used as the key for retrieving the value
from the dictionary variable.

d) Щелкните Сохранить.

9. Test the бот.
a) Click Run to run the бот.

After бот is deployed, the Favorite Song input box opens.
b) In the Favorite Song input box, enter a song title.
c) Щелкните OK.

A message box should display the string that the child bot returns. If no value returns, then
review the procedure to assign the incoming value to a dictionary key and a variable.
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Ссылки, связанные с данной
Dictionary пакет
The Dictionary пакет contains actions that enable you to do various operations on dictionary-type values.

Example of using a conditional statement
In this example, you build a бот that prints a message based on whether a cell has a value or is empty.
Use the actions from the Базовый Excel or Расширенный Excel, Если, and Message Box пакеты.
Before building this бот, save an empty Excel worksheet to the desktop.
Because this бот does not create a new Excel worksheet, you can use either the Базовый Excel or
Расширенный Excel пакеты.

Прим.:  All of the actions must be from the same пакет.

1. Откройте нового бот.
a) На левой панели щелкните Автоматизация.

Отобразится список доступных боты и форм.
b) Щелкните Создать > Бот.
c) Enter a бот name and click Create and edit.

2. Use the Open action from the Базовый Excel or the Расширенный Excel пакет to open the Excel
sheet.
a) Double-click or drag the Open action.
b) Введите имя сеанса.
c) Click Browse to provide the file path to the empty Excel worksheet on the desktop.

3. Use the Get single cell action to assign the value of a cell to a string variable.
a) Double-click or drag the Get single cell action from the same пакет that you used for the Open

action.
b) Provide the session name that you used in the Open action.
c) Select the Active cell option.
d) In the Store cell contents to field, create the variable Output.

4. Use the If action to configure the conditional statement.
a) Double-click or drag the If action.
b) Select String from the Condition drop-down list.
c) In the Source value field, insert the variable Output.
d) Select Equals to as the Operator.
e) Leave the Target value field empty.

5. Insert a Message box into the If container.
a) Drag the Message box action.
b) In the Enter the message to display field, enter Cell is empty.
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6. Use the Else and Message box actions to configure the alternative sequence of actions.
a) Drag the Else action next to the If action.
b) Drag the Message box action into the Else container.
c) In the Enter the message to display field, enter Cell is not empty.

7. Щелкните Сохранить.
8. Run the бот.

As the бот runs, the message box appears with the message Cell is empty.
9. Enter a value into the cell located at A1 in the Excel sheet and save the sheet.
10. Run the бот.

As the бот runs, the message box appears with the message Cell is not empty.

Ссылки, связанные с данной
Расширенный Excel пакет
The Расширенный Excel пакет contains actions that enable you to automate many of the repetitive tasks
when working with Microsoft Excel spreadsheets.
Если пакет
Use the actions in the Если пакет to control the sequence of execution based on one or more conditions
of a task.
Message box package
Use the Message box action from the Message box package to insert a message box that shows a
message when the task runs. For example, you can insert a Message Box action to follow a web form so
that the action displays the message: Web Form Filled and Complete.

Example of using Python script to join a list
Build a бот that uses a Python function to print the message Go Be Great!, the Automation Anywhere
version of Hello World. In this example, the бот combines a list of string values and prints them to a
message box.
To run Python script from Automation 360, you must already have the latest version of Python 3.x installed
on your device.
1. Create a new бот:

a) На левой панели щелкните Автоматизация.
b) Щелкните Создать > Бот.
c) In the Create Task Bot window, enter the бот name.
d) Accept the default folder location: \Bots\

To change the default бот storage location, click Choose and follow the prompts.
e) Щелкните Создать и редактировать.
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2. Create a variable to hold the list values:
a) Click the Create variable icon.
b) Enter lArgument in the Name field.

Recommendation:  Prefix the variable name with a lowercase character to indicate the variable
data type.
Variable naming

c) Select the List type and String subtype.
d) In the Default value field, enter the following values:

1. Value at 0: Go
2. Value at 1: Be
3. Value at 2: Great
4. Value at 3: !

e) Click Create.

3. Provide the script with a Python Script > Open action:
a) Double-click or drag the Python Script > Open.
b) Select the Manual input option.
c) Copy and paste the following text into the Enter script here field.

def data ( str ):
    x = " ".join( str )
    return x

4. Use a Python Script > Execute function action to tell the бот to run the script:
a) Double-click or drag Python Script > Execute function.
b) Enter data in the Enter name of function to be executed field.
c) Select the lArgument variable from the Arguments to the function drop-down list.
d) Create the variable sOutput for the Assign the output to variable field.

5. Insert a Message box action to hold the Python function output:
a) Double-click or drag the Message box > Message box action.
b) In the Enter the message to display field, select and insert the variable sOutput.
c) Select the Close message box after option. Retain the default value of 5 seconds in the field.

6. Close the script execution session with a Python Script > Close action:
a) Double-click or drag Python Script > Close.
b) Щелкните Сохранить.
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7. Click the Run icon.
The бот generates a message box with the text Go Be Great!. After 5 seconds, the message box
disappears.
To review the бот launcher logs, navigate to C:\ProgramData\AutomationAnywhere
\BotRunner\Logs\<current month>\Bot_Launcher-<today's date>.log.zip. Each
zipped folder contains a file with data on the code execution, which is useful for debugging.

Ссылки, связанные с данной
Python Script пакет
The Python Script пакет contains actions that enable Python Script functions in a task.
Message box package
Use the Message box action from the Message box package to insert a message box that shows a
message when the task runs. For example, you can insert a Message Box action to follow a web form so
that the action displays the message: Web Form Filled and Complete.

Example of using the DLL package
Build a very simple DLL that will generate a message. Create a бот to run the DLL.
This topic shows how to create a DLL package. If you do not have Microsoft Visual Studio, download the
free Community version from Microsoft Visual Studio Community IDE.
Create the DLL package.
1. In Microsoft Visual Studio, create a new class library that will generate a file type .dll by using C#.

a) Navigate to File > New > Project.
b) Search for dll in the Search for templates field.
c) Select the C# library option.
d) Configure your project as follows:

• Project name: DemoDLL
• Location: [Any]
• Solution Name: DemoDLL

e) Click Create.
f) Copy the following code and replace the contents of class1.cs by pasting:

using System;
using System.Collections.Generic;
using System.Linq;
using System.Text;
using System.Threading.Tasks;

namespace DemoDLL
{
    public class CallMe
    {
        public string ImHere()
        {
            String Reply = "You are now inside the DemoDLL, ImHere
 function!";
            return Reply;
        }
    }
}
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g) In Solution Explorer, right-click Class1.cs and rename it to "CallMe.cs".
h) Navigate to File > Save All.
i) Navigate to Build > Build Solution.

The output window confirms that the DLL package was successfully created and displays the path
to your new DemoDLL.dll package in the Output window. Note the package location, as you will
need it later to enter into the bot.

Create a бот to execute the DLL package.
2. Create a бот.

a) На левой панели щелкните Автоматизация.
Отобразится список доступных ботов и форм.

b) Click Create New > Bot.
c) Provide a name for theбот: MyDLLbot
d) Enter the folder location: Bots\TaskBotExample
e) Щелкните Создать и редактировать.

3. Create a variable: sReturnedString: string type.
Create a variable

4. Use a DLL > Open action to load your DLL package.
a) From the Actions pane, double-click or drag the DLL > Open action.
b) In the DLL:Open, Filepath field, select file type Desktop file and click Browse to find your

DLL package. Click Open.
c) Щелкните Сохранить.

5. Use a DLL > Run function action to execute your DLL package.
a) Double-click or drag the DLL > Run function action to the last line of the bot.
b) Click Get DLL Details.
c) Select Desktop file type and then click Browse. Locate your DLL package and click Open.
d) Щелкните Вперед.
e) Expand the DemoDLL namespace and select the CallMe function. Select method ImHere and

click Apply.
f) In the Assign the value to a variable field, select sReturnedString.

6. Use a Message box action to report what was returned from the DLL бот:
a) Double-click or drag the Message box action to the last line of the bot.
b) In the Enter the message to display field, type: From the DLL: "$sReturnedString$".

7. Щелкните Сохранить.
8. Use the DLL > Close action to end the DLL session.

a) Double-click or drag the DLL > Close action to the last line of the bot.

9. Щелкните Сохранить.
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10. Click the List tab to view your code in text-only mode.
Your code should look like this:

Start
DLL:Open "C:\myFolder\source\repos\DemoDLL\DemoDLL\bin\Debug\DemoDLL.dll
 for session "Default"
DLL:Run function "ImHere" and store output in variable $sReturnedString$
 and session "Default"
MessageBox "From the DLL: "$sReturnedString$".
DLL:Close session "Default"
End

11. Run your бот.
The DLL package returns a message to the bot: From the DLL: "You are now inside the
DemoDLL, ImHere function!".

Ссылки, связанные с данной
DLL пакет
A dynamic-link library (DLL) file contains a shared library of functions that can be used by Windows
programs. The DLL пакет uses a .dll file as reference and calls functions from the бот.

Example of transferring data from CSV file to Excel worksheet
In this example, you build a бот to update the product inventory in an Excel worksheet with new product
names from a CSV file. Use actions from the CSV/TXT, Расширенный Excel, IF/ELSE, and Цикл пакеты.
Before you start building the бот, create the following data sets on your desktop in the specified file
formats:
Data set 1: ProductInventory.xlsx

Item number Имя Счетчик Категория Unit price Taxable

A0001 Milk 15 Grocery 3 N

A0002 Eggs 6 Grocery 4 N

A0003 Flower 3 Garden 10 Y

A0004 Таблица 1 Главная
страница

50 Y

A0005 Towel 4 Главная
страница

10 Y

A0006 Dog Food 16 Pet 22 N

A0007 Paint 43 Главная
страница

12 Y

Data set 2: NewProductNames.csv

Item number Имя

A0005 Hand Towel

A0002 Chicken Eggs

A0003 Sunflower

A0004 Coffee Table
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Item number Имя

A0006 Dog Food - Small Dogs

A0007 Paint - Dark Blue

A0001 2% Milk

In this example, you will build a бот to update the product inventory in an Excel worksheet with new
product names from a CSV file. The Excel worksheet has old product names and the CSV file has new
product names. You will relate the data in the Excel worksheet and the CSV file with item number and
update the Excel worksheet with the new item name corresponding to the item number. Use actions from
the CSV/TXT, Расширенный Excel, IF/ELSE, and Цикл пакеты
1. Create a new бот:

a) На левой панели щелкните Автоматизация.
b) Щелкните Создать > Бот.
c) In the Create Task Bot window, enter the бот name.
d) Accept the default folder location: \Bots\

To change the default бот storage location, click Choose and follow the prompts.
e) Щелкните Создать и редактировать.

2. Open the NewProductNames.csv file that you just created.
a) Double-click or drag the CSV/TXT > Open action.
b) In the Session name field, enter session 1.
c) Provide the file path to NewProductNames.csv.
d) Select the Contains header option.

3. Open the ProductInventory.xlsx file that you just created.
a) Double-click or drag the Excel advanced > Open action.
b) In the Session name field, enter session 2.
c) Provide the file path to ProductInventory.xlsx.
d) Choose to open the file in Read-write mode.
e) Select the Contains header option.

4. Use the Go to cell action to indicate the first cell in which to update the product names.
a) Double-click or drag the Excel advanced > Go to cell action.
b) In the Session name field, enter session 2.
c) Select the Specific cell option and enter B2.

5. Use a Loop action to retrieve the cell values in each row from ProductInventory.xlsx.
a) Дважды щелкните или перетащите action Цикл.
b) Select the Excel Advanced > For each row in worksheet iterator.
c) In the Session name field, enter session 2.
d) In the Loop through field, select All rows.
e) In the Assign current value to this variable field, create a rInventory variable.

© 2023 Automation Anywhere. All rights reserved.     2079



    Automation Anywhere - Сборка

6. Use a Loop action to retrieve the cell values in each row from NewProductNames.csv.
a) Drag the Loop action into the For each row in worksheet Loop container.
b) Select the For each row in CSV/TXT iterator.
c) In the Session name field, enter session 1.
d) In the Assign current value to this variable field, create a rNewProduct variable.

7. Use an If action to compare the item number from ProductInventory.xlsx to the item number
from NewProductNames.csv to ensure they are the same before moving on to the next action.
a) Double-click or drag the If action into the For each row in csv/txt Loop container.
b) Выберите условие Строка.
c) In the Source value field, input rInventory[0].
d) Select the Equals to (=) operator.
e) In the Target value field, input rNewProduct[0].

8. Use the Set cell and Go to cell actions to update the product name and move to the cell below.
a) Double-click or drag the Excel Advanced > Set cell action.
b) In the Session name field, enter session 2.
c) Select the Active cell option.
d) In the Cell value field, input rNewProduct{Name}

e) Double-click or drag the Excel Advanced > Go to cell action.
f) In the Session name field, enter session 2.
g) From the Active cell drop-down list, select One cell below.

9. Insert an alternative to the If action: if the item numbers are not the same, the бот continues to the
next row in NewProductNames.csv.
a) Drag the If > Else action.
b) Drag the Loop > Continue action.

10. Close the files.
a) Double-click or drag the Excel advanced > Close action.
b) In the Session name field, enter session 2.
c) Select the Save changes option.
d) Double-click or drag the CSV/TXT > Close action.
e) In the Session name field, enter session 1.

11. Щелкните Сохранить.
12. Run the бот.

The бот updates the ProductInventory.xlsx file to look like the following table:
Data set 3: ProductInventory.xlsx

Item number Имя Счетчик Категория Unit price Taxable

A0001 2% Milk 15 Grocery 3 N

A0002 Chicken Eggs 6 Grocery 4 N
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Item number Имя Счетчик Категория Unit price Taxable

A0003 Sunflower 3 Garden 10 Y

A0004 Coffee Table 1 Главная
страница

50 Y

A0005 Hand Towel 4 Главная
страница

10 Y

A0006 Dog Food -
Small Dogs

16 Pet 22 N

A0007 Paint - Dark
Blue

43 Главная
страница

12 Y

Ссылки, связанные с данной
CSV/TXT package
The CSV/TXT package contains actions that enable you to open a CSV or text file, read data from that
file, and assign the data to a Table variable. This package supports files encoded in ANSI, Unicode, UTF-8,
or Windows-1251, and can process up to one million records.
Расширенный Excel пакет
The Расширенный Excel пакет contains actions that enable you to automate many of the repetitive tasks
when working with Microsoft Excel spreadsheets.
Если пакет
Use the actions in the Если пакет to control the sequence of execution based on one or more conditions
of a task.
Цикл пакет
Use the Цикл package to run a sequence of actions repeatedly for a specific number of times or until a
specific condition is met.

Run TaskBot to merge Excel sheets
Download and run sample TaskBot from the Bot Store to merge two spreadsheets.
Complete these requirements for using the example TaskBot:
• Microsoft Excel must reside on the Bot Runner device
• Automation 360 Build 4088 or later
• Excel Advanced package version 2.0.0-20200422-000103 or later
• Two spreadsheets as input: Both sheets must have common data within column A, such as a product or

customer number

You can manually create the spreadsheets with columns similar to the following tables 1 and 2.
Sheet 1 has columns to append to sheet 2 where a common value resides in column A. The бот
expects the file locations and names to be c:\bot_test\Spreadsheet1.xlsx and c:\bot_test
\Spreadsheet2.xlsx.
Table 1

Item
Number

Имя Счетчик КатегорияUnit
Price

Taxable Backorder Perishable Регион

A0001 Milk 15 Grocery 3 N Y Y США
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Item
Number

Имя Счетчик КатегорияUnit
Price

Taxable Backorder Perishable Регион

A0005 Towel 4 Главная
страница

10 Y N N США

A0006 Dog Food 16 Pet 22 N N N США

A0007 Paint 43 Главная
страница

12 Y N N IN

Table 2

Item Number Имя Brand Popular Unit Price TTS

A0001 Milk Wholesome
Foods

Y 3 1

A0002 Eggs Dairy Love Y 4 1

A0003 Flower Spring Me Up! N 10 3

A0004 Таблица Woods Are Us N 50 10

A0005 Towel Claire Dane N 10 6

A0006 Dog Food Purina Y 22 3

A0007 Paint Color the
World

N 12 2

1. Get the Merge Excel Sheets Example бот from the Bot Store.
The бот is automatically loaded to your Automation 360 On-Premises or Cloud environment.
You will receive an email with instructions for installing the бот in Automation 360 from the Bot Store.

2. Follow the instructions carefully. If you do not have the Bot Developer role assigned, contact your
administrator to add the role.

3. If your spreadsheets are not located at c:\bot_test\Spreadsheet1.xlsx and c:\bot_test
\Spreadsheet2.xlsx, update lines 5 and 9 of the бот with your desktop file location.

4. Run the TaskBot.
5. Update the TaskBot with any changes that reflect your use case, and make it your own.

You can also use the бот as a template for future Excel Advanced TaskBots by copying and saving it
with a new name.

Ссылки, связанные с данной
Расширенный Excel пакет
The Расширенный Excel пакет contains actions that enable you to automate many of the repetitive tasks
when working with Microsoft Excel spreadsheets.

Пример переноса данных из Excel в базу данных
В этом примере вы создаете бот для передачи значений из таблицы Excel в базу данных с
использованием actions из пакеты База данных, Расширенный Excel и Цикл.
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Прежде чем приступить к формированию бот, создайте следующее:
• Создайте таблицу Excel со следующими значениями и сохраните ее (например:

Test_migration_db.xlsx)

Джон Уильямс (John
Williams)

jwilliams@cmail.com

Сэм Ли (Sam Li) sam.li@xyz.org

Карл Миллер (Carl
Miller)

carl@carlmillerllc.com

• Создайте таблицу базы данных Access с именем CustomerT со следующими столбцами:
(создайте базу данных, подобную изображенной ниже, и сохраните ее, например, как
Test_Migration_db.accdb)
• Имя
• Фамилия
• Эл. почта

Чтобы перенести значения из электронной таблицы в таблицу базы данных, выполните указанные
ниже действия.
1. Create a new бот:

a) На левой панели щелкните Автоматизация.
b) Щелкните Создать > Бот.
c) In the Create Task Bot window, enter the бот name.
d) Accept the default folder location: \Bots\

To change the default бот storage location, click Choose and follow the prompts.
e) Щелкните Создать и редактировать.
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2. Откройте электронную таблицу:
a) Дважды щелкните или перетащите action Расширенный Excel > Открыть.
b) Щелкните Обзор, чтобы указать путь к файлу.

c) Выберите вариант открытия файла в режиме Чтения и записи.
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3. Подключитесь к базе данных:
a) Дважды щелкните или перетащите action База данных > Подключить.
b) Выберите режим подключения Определено пользователем.

c) Выберите тип базы данных Microsoft Access.
d) Щелкните Обзор, чтобы указать путь к файлу.
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4. Вставьте значения Excel в базу данных, строка за строкой:
a) Дважды щелкните или перетащите action Цикл.
b) Выберите итератор Расширенный Excel > Для каждой строки на листе.
c) Выберите Все строки в раскрывающемся списке Цикл до.

d) В поле «Присвоить текущее значение этой переменной» создайте переменную записи
rExcelCurrentRow.

e) Перетащите action База данных > Вставить/обновить/удалить в контейнер «Цикл».
f) Введите следующую инструкцию SQL:

INSERT INTO CustomerT (FirstName,LastName,Email) values
 ('$rExcelCurrentRow[0]$','$rExcelCurrentRow[1]$','$rExcelCurrentRow[2]$');
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5. Отключитесь от базы данных. Перетащите action База данных > Отключить в область ниже
контейнера «Цикл».

6. Закройте электронную таблицу. Дважды щелкните или перетащите action Расширенный Excel
> Закрыть электронную таблицу.

7. Щелкните Сохранить.

Ссылки, связанные с данной
База данных пакет
Базы данных поддерживают внутренние операции предприятия, сохраняя разнообразные данные,
такие как транзакции продаж, каталоги продуктов, складские запасы и профили клиентов. Use the
База данных пакет to connect to a database, begin a transaction, and manipulate the stored data by
retrieving, inserting, updating, deleting, and exporting it to a CSV file.
Расширенный Excel пакет
The Расширенный Excel пакет contains actions that enable you to automate many of the repetitive tasks
when working with Microsoft Excel spreadsheets.
Цикл пакет
Use the Цикл package to run a sequence of actions repeatedly for a specific number of times or until a
specific condition is met.
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Example of using the Run action
The Run action from the TaskBot пакет enables you to run and pass values to one or more child боты. In
this example, you use the Run action to pass two values from a parent бот to the child бот; the child бот
adds the values and passes the sum back to the parent бот.
This example demonstrates the following:

Modularization Modularization separates a TaskBot into several
боты, where each бот is built with all the actions
necessary to perform one specific function of the
greater task.
In this example, you build a single child бот to add
the values. You can build several child боты, with
each performing a different mathematical operation,
and edit the parent бот to call whichever one you
want to use.

Reusability Reusability enables the user to build a бот once,
and then use that бот to automate many processes.
The child бот contains only the actions necessary
to add the values and print them to a Message Box.
Also, the бот adds two variables instead of hard-
coded values. As a result, this бот can be reused for
any task that involves an addition operation.

Data control Because the child бот accepts and returns values
only through the use of variables, it does not hold
data. This minimizes the chance of data leakage.

To run a TaskBot from the current task, perform these steps:
Build the child бот.
1. Откройте нового бот.

a) На левой панели щелкните Автоматизация.
Отобразится список доступных ботов и форм.

b) Щелкните Создать бота.
c) Enter the бот name AddChildBot.
d) Введите местоположение папки Bots\TaskBotExample.

Чтобы изменить папку сохранения бот, щелкните Выбрать и следуйте подсказкам.
e) Щелкните Создать и редактировать.

2. Create the following variables:
• v1: number type; use as input
• v2: number type; use as input
• nSum: number type
• sSum: string type; use as output

Create a variable
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3. Use a Number > Assign action to perform the mathematical operation.
a) Double-click or drag the Number > Assign action.
b) In the Select the source string variable/ value field, enter the following expression: $v1$ +

 $v2$

c) Select nSum from the Select destination number variable list.

4. Use the Number > To string action to convert the value so it can be printed to a Message Box.
a) Double-click or drag the Number > To string action.
b) In the Enter a number field, enter the following expression: $nSum$
c) Select sSum from the Assign output to variable list.

5. Щелкните Сохранить.
6. Щелкните Закрыть.
Build the parent бот.
7. Откройте нового бот.

a) On the left panel, click Automation
Отобразится список доступных ботов и форм.

b) Щелкните Создать бота.
c) Enter the бот name MathBot.
d) Enter the folder location \Bots\TaskBotExample.

Чтобы изменить папку сохранения бот, щелкните Выбрать и следуйте подсказкам.
e) Щелкните Создать и редактировать.

8. Create a Dictionary variable of Any subtype named dSums to accept the values passed from the child
бот.
Use the Any subtype to enable the parent бот to accept String, Number, or Boolean type values.

9. Insert a Task Bot > Run action to specify the values for the mathematical operation and the output
variable to hold the sum.
a) Double-click or drag the Task Bot > Run action.
b) Click Browse to navigate to Bots\TaskBotExample\AddChildBot.
c) Enter the following values in the Input values fields:

• v1: 12
• v2: 54

d) Select dSums from the Assign output to variable list.

Прим.:  Use a Dictionary variable to hold the output of the Run action in order to make the
parent бот more versatile. This way a parent бот can handle different child боты regardless of
whether they return a single value or several values.
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10. Use a Message Box to retrieve and print the sum.
The variable sSum retrieved from the child бот is a key in the Dictionary variable dSums.

Прим.:  You must know the variable names from the child бот to extract them from the parent бот.
The interface does not automatically import the variable names to the parent бот.

a) Double-click or drag the Message box action.
b) Enter $dSums{sSum}$ in the Message to display field.

11. Щелкните Сохранить.
12. Click Run.

The бот runs and the Message Box appears containing the sum 66.

Ссылки, связанные с данной
TaskBot пакет
Use the Run, Pause, and Stop actions in the TaskBot пакет to manage running one or more child боты
from a parent бот or with a third-party software using an API.
Message box package
Use the Message box action from the Message box package to insert a message box that shows a
message when the task runs. For example, you can insert a Message Box action to follow a web form so
that the action displays the message: Web Form Filled and Complete.

Пример использования действия веб-службы SOAP
Используйте action Веб-служба SOAP для передачи двух числовых значений и возврата суммы из
веб-приложения «калькулятор».
Чтобы вызвать веб-службу SOAP, выполните указанные ниже действия.
1. Дважды щелкните или перетащите действие Веб-службы SOAP.
2. Выберите метод подключения:

• To connect using a URI, enter the URI, for example, http://www.dneonline.com/
calculator.asmx?WSDL.

• Чтобы подключиться с помощью файла, выберите файл в Control Room или на рабочем столе
или вставьте переменную.

3. Необязательно: Укажите конечную точку SOAP в поле Расположение адреса.
Если указать расположение адреса, то бот использует его во время выполнения; в противном
случае бот использует местоположение адреса из WSDL-файла.

Прим.:  Если URI SOAP создается вручную, без использования команды Создать запрос SOAP,
перейдите к шагу 6.

4. Щелкните Создать запрос SOAP.
Появляется окно Запрос SOAP, в котором отображаются службы и порты с подробной
информацией об их операциях и параметрах.

5. В окне Запрос SOAP разверните запись службы, для которой требуется просмотреть список
портов. Чтобы отобразить список доступных операций, щелкните нужный порт. Чтобы
получить сведения об операции из запроса SOAP, выберите необходимую операцию и щелкните
Применить.
Если используется команда Создать запрос SOAP, поля Службы, Порт, Операция и
Параметры операции автоматически заполняются сведениями в зависимости от выбранной
операции. Перейдите к шагу 10.
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6. В поле Служба введите имя службы.
Это поле определяет набор портов, поддерживаемых веб-службой. В нем содержится
значение@имени службыдля вызова веб-службы SOAP, например, Calculator.

7. Необязательно: В поле Порт укажите конечную точку для подключения.
Если не указать порт, бот будет использовать первый порт, указанный в WSDL-файле, в
зависимости от выбранной службы. Однако, если этот порт не поддерживается веб-службой
SOAP, выполнение бот завершится ошибкой.
В этом поле хранится значение@имени привязкидля вызова веб-службы SOAP, например,
CalculatorSoap.

8. Выберите версию SOAP конечной точки, которую вы указали в поле Порт.
Выберите 1.1 или 1.2.

9. В поле Операция введите имя сервисной функции для конечной точки, которую вы указали в
поле Порт.
Выполнение бот завершается ошибкой, если верно одно из указанных ниже условий.
• Для порта, указанного в поле «Порт», нет никаких операций.
• Операция, указанная в запросе SOAP для данного порта, недоступна.

В этом поле хранится значение@названия операциидля вызова веб-службы SOAP, например,
Add.

10. Выберите Параметры операции или Параметры с необработанными данными для
получения подробной информации о параметрах.

Прим.:  Если выбрана команда Создать запрос SOAP, таблица сведений о параметрах на
вкладке Операция автоматически заполняется параметрами выбранной операции. Укажите
значения этих параметров. Также можно добавлять, редактировать или удалять параметры для
конкретной операции.

• При выборе варианта Параметры операции введите название и значение каждого
параметра. Например, введите указанные ниже значения.
a. intA в первом поле Имя
b. 10 в первом поле Значение
c. intB во втором поле Имя
d. 20 во втором поле Значение

• При выборе варианта Параметры с необработанными данными выберите Параметры
или Параметры учетных данных.

11. Параметры: Можно использовать значения учетных данных из ячейки «Компонент учетных
данных», не раскрывая учетные данные (имя пользователя или пароль) в виде обычного текста
в необработанных данных. Для этого сначала необходимо сопоставить учетные данные в
модуле сопоставления учетных данных и использовать имя ссылки в необработанных данных,
заключенное в фигурные скобки.
Например, в необработанных данных вы предоставили пароль в виде обычного текста для
аутентификации на сервере.

<aut:AuthHeader>
<aut:Password> abc@123</aut:Password>
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</aut:AuthHeader>

Чтобы использовать пароль из ячейки учетных данных, выполните указанные ниже действия.
a) Щелкните Добавить подстановку.

В поле Имя в XML введите имя ссылки, например pwd. Выберите Компонент учетных
данных, чтобы использовать значение, доступное в хранилище учетных данных,
Переменная, чтобы использовать переменную учетных данных, или Небезопасная
строка, чтобы вручную указать значение, которое требуется использовать.
Подробнее о хранилищах учетных данных и о том, как их использовать, см. в разделе
Credentials and ячейки in the Credential Vault.

b) Щелкните Добавить
c) Укажите ссылку в необработанных данных в фигурных скобках, как показано ниже.

<aut:AuthHeader>
<aut:Password>{{pwd}}</aut:Password>
</aut:AuthHeader>

The reference name pwd specified in raw data will substitute the corresponding value stored in
the credential vault.
Убедитесь, что имя ссылки введено в том же формате, который указан в поле Добавить
подстановку. For example, if you have entered password as pwd in Add substitution
and enter password as reference name in the raw data, when you run the бот, the бот will
encounter an error.

12. Параметры учетных данных: Если требуется ввести параметры необработанных данных в
качестве учетных данных, можно выбрать Компонент учетных данных, чтобы использовать
значение, доступное в хранилище учетных данных, или Переменная, чтобы использовать
переменную учетных данных, или небезопасную строку, чтобы вручную указать значение,
которое требуется использовать.

13. Выберите Без проверки подлинности или Базовая из Режим проверки подлинности
список.
• Выбрав Без проверки подлинности, перейдите к следующему шагу.
• Выбрав вариант Базовый, введите свои учетные данные.

14. Необязательно: Предоставьте сертификат клиента, выбрав файл в Control Room или на рабочем
столе, или вставьте переменную.

15. Необязательно: Предоставьте настраиваемые заголовки.
16. Необязательно: Укажите файл для сохранения выходных данных XML.
17. Выберите Полный ответ или Выбранный ответ, чтобы сузить рамки ответа.

• Выбрав Полный ответ, перейдите к следующему шагу.
• При выборе параметра Выбранный ответ, если вы создаете выражение XPath вручную, не

используя параметр Создать XPath, выполните указанные ниже действия.
a. Предоставьте выражение XPath. Пример.

/*[local-name()='Envelope' and namespace-uri()='http://
schemas.xmlsoap.org/soap/envelope/']/*[local-name()='Body' and
 namespace-uri()='http://schemas.xmlsoap.org/soap/envelope/']/
*[local-name()='AddResponse' and namespace-uri()='http://
tempuri.org/']/*[local-name()='AddResult' and namespace-
uri()='http://tempuri.org/']

b. Выберите раздел выходного XML-файла: Значения, Внутренний XML или Внешний
XML.
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c. If you select the option Values, choose return content as: String delimited by or List of
strings.
• If you select String delimited by, choose a delimiter option: Прямая черта, Точка с

запятой или Пользовательский.
Если вы выбрали Пользовательский, введите переменные или символы в поле
Пользовательский разделитель (необязательно).

Прим.:  Специальный символ «знак доллара» ($) в качестве разделителя не
поддерживается.

• Select List of strings to return the output of the soap response as list of strings.

Прим.:  You can only specify a list type of variable with data type as strings.

18. Щелкните Создать Xpath.
Открывается окно предварительного просмотра выходных данных.

19. Выберите соответствующий узел из тела ответа. Путь XML создается автоматически. Щелкните
Применить.
Если используется команда Создать Xpath, поля Выражение XPath и Значение поля
автоматически заполняются сведениями на основе выбранной операции.

20. Необязательно: Чтобы установить значение ожидания при отправке SOAP-запроса и получении
ответа, укажите время ожидания (в миллисекундах) в параметре Время ожидания
завершения действия.
По умолчанию время ожидания составляет 60 000 миллисекунд.

21. Configure the P12 certificate:
• To get the SSL certification file, select one of the following options: Control Room file, Desktop

file, or Variable
• Configure the Keystore properties:

• Keystore file (Optional): To provide the keystore file in. p12 format, select one of the
following options: Control Room file, Desktop file, or Variable. The keystore file includes
the client's private key and certificate.

• Keystore password (Optional): To provide the password for the keystore file, select one of
the following options: Credential, Variable , or Insecure string. The password is used to
access the keystore file.

22. Выберите переменную для сохранения выходных данных XML.
For example, prompt-assignment

23. Verify the output of the SOAP web service action by inserting a Message box action with the
variable prompt-assignment in the body message.
При запуске бот в окне сообщения должно отображаться значение 30.

Ссылки, связанные с данной
Веб-служба SOAP пакет
Use the SOAP web service action from the Веб-служба SOAP пакет to access and exchange information
between two systems in XML format.
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Example of using Get structure command from SAP BAPI пакет
Using the SAP BAPI пакет, build a бот that inputs a structure to get data.
Download the SAP Java connector and DLL from the SAP website.
In this tutorial, you will build a  that invokes BAPI_FLIGHT_GETLIST from the SAP demo Flight Data
application. When executed, the  calls the BAPI function by inputting an airline ID and destination details,
gets a list of flights, and writes the response data to a CSV file.
You will use the following import parameters to limit your search:
• AIRLINE: Use the parameter to pass the airline ID.
• DESTINATION_FROM: Use the parameter to get the structure and pass the city name and airport ID.

The tutorial is intended to demonstrate how to perform the following actions:
• Get the structure of an import parameter.
• Set the values for the fields in the retrieved structure.
• Get response data in a table based on the input data.

1. Create a TaskBot named SAP-BAPI-FlightListReport.
a) Log in to Control Room.
b) На левой панели щелкните Автоматизация.
c) Click the Create a bot icon.
d) In the Name field, enter SAP-BAPI-FlightListReport, and click Create & Edit.

2. To connect the  to your SAP system, from the Actions panel, find SAP BAPI > Connect action and
add it to the .
a) In JCo: SAP Java Connector package, specify the path to the Java connector .jar file.
b) In JCo DLL dependency, specify the path to the DLL file.
c) Choose Custom Application Server as Connection Type.
d) In Application server host name, specify the host name of the SAP application server.

Прим.:  As a best practice, use the  to specify sensitive information such as host name, user
name, and password.

e) In System number, enter the instance number.
f) In SAP instance system ID, enter the system ID.
g) In Client number, enter the client number.
h) In Logon language code, enter EN or the language specific to your system.
i) In Router string, enter the SAP router string.
j) In Username, enter your SAP user name.
k) In Password, enter your password.
l) Run the  to test the connection.

If the specified connection properties are correct, the bot is executed successfully.
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3. To create a function, add the SAP BAPI > Create function action.
a) In Function alias name, enter getFlightListByAirline.
b) In BAPI name, enter BAPI_FLIGHT_GETLIST.

4. To filter the data by an airline name, add the SAP BAPI > Set field value action.
a) In Function alias name, enter getFlightListByAirline.
b) Click the Function tab.
c) In Field name, enter AIRLINE as the input parameter name.
d) In Field value, enter AZ.

5. To limit the selection by the airport and the destination city, get the structure of the
DESTINATION_FROM import parameter first, and then set values for the fields in the retrieved
structure. To do this, add the SAP BAPI > Get structure action.
a) In Function alias name, enter getFlightListByAirline.
b) In Structure name, enter DESTINATION_FROM.
c) To assign the retrieved structure to an alias, click the Alias tab in Destination, and enter

destinationFrom in Create structure alias.
You can now use the alias to set values for the fields in the retrieved structure.

6. To set a value for the AIRPORT ID field in the DESTINATION_FROM parameter, add the SAP BAPI >
Set field value action.
a) In Function alias name, enter getFlightListByAirline.
b) In Source, click the Structure tab.
c) In Structure alias, enter destinationFrom.
d) In Field name, enter AIRPORTID.
e) In Field value, enter FCO.

7. To set a value for the CITY field in the DESTINATION_FROM parameter, add the SAP BAPI > Set
field value action.
a) In Function alias name, enter getFlightListByAirline.
b) In Source, click the Structure tab.
c) In Structure alias, enter destinationFrom.
d) In Field name, enter CITY.
e) In Field value, enter ROME.

8. To execute BAPI_FLIGHT_GETLIST, add the SAP BAPI > Run function action.
a) In Function alias name, enter getFlightListByAirline.

9. To get the filtered data from the FLIGHT_LIST table, add the SAP BAPI > Get table action.
a) In Function alias name, enter getFlightListByAirline.
b) In Table name, click the FLIGHT_LIST tab.
c) In Destination, click Variable to store the retrieved table data in memory.
d) In Save the outcome to a variable, create a variable named tblFlightList by clicking (x).
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10. To write the data from the retrieved table to a CSV file, add the Data Table > Write to file action.
a) In Data table, select tblFlightList.
b) In Enter file name, specify the path to the CSV file to which you want to write the data.
c) Select Create folders/files if it doesn't exist.
d) Click Overwrite existing file.

11. Save and then run the бот.

Example of writing data to SAP using SAP BAPI пакет
Using the SAP BAPI пакет, build a бот that writes data to the SAP database.
Download the SAP Java connector and DLL from the SAP website.
In this tutorial, you will build a  that invokes BAPI_FLCUST_CREATEFROMDATA from the SAP demo Flight
Data application. You will use the CUSTOMER_DATA import parameter to pass the customer data to the
BAPI. When executed, the  creates a new customer record in SAP database and displays the customer
number returned by the BAPI.
The tutorial demonstrates how to perform the following actions:
• Use the Get structure command to set values for the import parameters.
• Create a new record in an SAP table.
• Receive a response from a BAPI.

1. Create a бот named SAP-BAPI-CreateNewFlightCustomer.
a) Войдите в Control Room.
b) На левой панели щелкните Автоматизация.
c) Click the Create a bot icon.
d) In the Name field, enter SAP-BAPI-CreateNewFlightCustomer, and click Create & Edit.
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2. To connect the  to your SAP system, from the Actions panel, find SAP BAPI > Connect action and
add it to the .
a) In JCo: SAP Java Connector package, specify the path to the Java connector .jar file.
b) In JCo DLL dependency, specify the path to the DLL file.
c) Choose Custom Application Server as Connection Type.
d) In Application server host name, specify the host name of the SAP application server.

Прим.:  As a best practice, use the  to specify sensitive information such as host name, user
name, and password.

e) In System number, enter the instance number.
f) In SAP instance system ID, enter the system ID.
g) In Client number, enter the client number.
h) In Logon language code, enter EN or the language specific to your system.
i) In Router string, enter the SAP router string.
j) In Username, enter your SAP user name.
k) In Password, enter your password.
l) Run the  to test the connection.

If the specified connection properties are correct, the bot is executed successfully.

3. To create a function, add the SAP BAPI > Create function action.
a) In Function alias name, enter createNewFlightCustomer.
b) In BAPI name, enter BAPI_FLCUST_CREATEFROMDATA.

4. Because the CUSTOMER_DATA parameter is of the type structure, get the structure of the import
parameter and assign it to an alias. To do this, add the SAP BAPI > Get structure action.
a) In Function alias name, enter createNewFlightCustomer.
b) In Structure name, enter CUSTOMER_DATA.
c) To store the retrieved structure as an alias, click the Alias tab in Destination.
d) In Create structure alias, enter CustomerData.

You will use the alias to set values for the import field within the retrieved structure.

5. To set the value for the CUSTNAME field, add the SAP BAPI > Set field value action.
a) In Function alias name, enter createNewFlightCustomer.
b) In Source, click the Structure tab.
c) In Structure alias, enter CustomerData.
d) In Field name, enter CUSTNAME.
e) In Field value, enter John Doe.

6. Repeat Step 5 to add and configure the Set field value action for each of the following fields:

Имя поля Значение поля

STREET testStreet

POSTCODE 101001
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Имя поля Значение поля

CITY testCity

COUNTR US

COUNTR 00000000

EMAIL test@example.com

CUSTTYPE P

7. To execute BAPI_FLCUST_CREATEFROMDATA, add the SAP BAPI > Run function action.
a) In Function alias name, enter createNewFlightCustomer.

Прим.:  If you want BAPI_FLCUST_CREATEFROMDATA to write the data to SAP database, you must
select the End sequence and the Commit transaction options. If you select the End sequence
option, ensure that you select the Begin sequence option in the Create function action.
The sample бот created with the help of this tutorial is intended to demonstrate how the Create()
BAPIs work when the SAP BAPI пакет is used. It is not intended to modify the database.

The BAPI assigns and returns a customer number after a new customer record is created.
8. To get the number into a variable, add the SAP BAPI > Get field value action.

a) In Function alias name, enter createNewFlightCustomer.
b) In Source, click the Function tab.
c) In Field name, enter CUSTOMERNUMBER
d) In Save the outcome to a variable, create a variable named strCustomerNumber by clicking

(x) and select the variable.

9. To display the customer number, add the Message Box action.
a) In Enter the message to display, select the strCustomerNumber variable.

10. Save and run the бот.

Example of using Run standard workflow from SAP BAPI пакет
Using the Run standard workflow action from the SAP BAPI пакет, build a бот that retrieves data from SAP
systems.
Download the SAP Java connector and DLL from the SAP website.
In this tutorial, you will build a бот that uses the Run standard workflow action. The Run standard
workflow action provides a user interface that enables you to select BAPIs and configure the parameters
for the selected BAPI.
By using this single SAP BAPI пакет action, you will perform the following actions:
• Select a BAPI (BAPI_FLIGHT_CHECKAVAILABILITY) from a list of function modules available in the

connected SAP system.
• Set values for the import and export parameters of the selected BAPI.
• Assign retrieved structure or tables to dictionary or table variables.
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When executed, the бот gets flight availability data based on the input data, and writes it to a CSV file.
1. Create a бот named SAP-BAPI-CheckFlightAvailability.

a) Войдите в Control Room.
b) На левой панели щелкните Автоматизация.
c) Click the Create a bot icon.
d) In the Name field, enter SAP-BAPI-CheckFlightAvailability, and click Create & Edit.

2. To connect the  to your SAP system, from the Actions panel, find SAP BAPI > Connect action and
add it to the .
a) In JCo: SAP Java Connector package, specify the path to the Java connector .jar file.
b) In JCo DLL dependency, specify the path to the DLL file.
c) Choose Custom Application Server as Connection Type.
d) In Application server host name, specify the host name of the SAP application server.

Прим.:  As a best practice, use the  to specify sensitive information such as host name, user
name, and password.

e) In System number, enter the instance number.
f) In SAP instance system ID, enter the system ID.
g) In Client number, enter the client number.
h) In Logon language code, enter EN or the language specific to your system.
i) In Router string, enter the SAP router string.
j) In Username, enter your SAP user name.
k) In Password, enter your password.
l) Run the  to test the connection.

If the specified connection properties are correct, the bot is executed successfully.

3. From the Actions panel, find SAP BAPI > Run standard workflow action after the Connect
action.

4. Select a BAPI.
a) Click the Select workflow option.
b) In the Standard BAPI Selector window, from Select Standard BAPI, expand SAP Modules.
c) Find and expand Flight with connection data (SAP training).
d) In Flight with connection data (SAP training), expand General > Create, select

BAPI_FLIGHT_CHECKAVAILABILITY, and then click Select.
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5. Specify values for the fields in the import parameter. Do the following in Import to BAPI:
a) Click the vertical ellipsis option for the AIRLINEID field, and select Edit.
b) In Value, enter DL and click Apply.
c) Click the vertical ellipsis option for the CONNECTIONID field, and select Edit.
d) In Value, enter 1699 and click Apply.
e) Click the vertical ellipsis option for the FLIGHTDATE field, and select Edit.
f) In Value, enter 20170418 and click Apply.

The Java connector for SAP systems takes the date values in the yyyymmdd format.

BAPI_FLIGHT_CHECKAVAILABILITY returns data in the AVAILABILITY export parameter, which is
of the type structure.

6. In Export to BAPI, perform the following steps:
a) Click the ellipsis option for the AVAILABILITY field.
b) On the Availability window, select the Field name check box to select all fields within the

structure, and then click Apply.

7. Store the data that the BAPI exports to a variable.
a) In Save exported structures and scalars, create a variable by clicking (x) and name it

ReturnStructure.

8. In Save exported structures and scalars, create a variable by clicking (x) and name it
ReturnStructure.

9. Save the Run standard workflow action.
10. Convert the exported data to a table.

a) From the Actions panel, find Dictionary > Get action, and add it after the Run standard
workflow action.

b) Click inside Dictionary variable and select ReturnStructure.
c) In Key, enter AVAILABILITY.
d) In Assign the output to variable, create a variable by clicking (x) and name it Availability.

11. To write the data from the retrieved table to a CSV file, add the Data Table > Write to file action.
a) In Data table, select Availability.
b) In Enter file name, specify the path to the CSV file, to which you want to write the data.
c) Select Create folders/files if it doesn't exist.
d) Click Overwrite existing file.

12. Save and run the бот.

Example of using the VBScript package in a resilient bot
Build a bot that executes a Microsoft Visual Basic script. Use the Try/Catch package to gracefully end the
bot if it fails, making it resilient to crashes. A resilient bot allows scheduled and queued bots to continue
even if the current bot encounters an error.
In this bot, you ask the user to provide a number. The bot passes the number to a Microsoft Visual Basic
script to multiply by pi and return the value. The bot then reports the result to the user. You can use the
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VBScript action to either import an external script or type it directly into your bot. In this example, you
manually type the script. You also add resiliency to the bot by adding error handling.
1. Create a бот:

a) На левой панели щелкните Автоматизация.
Отобразится список доступных ботов и форм.

b) Click Create New > Bot.
c) Provide a name for the бот: MultiplyPi
d) Enter the folder location: Bots\TaskBotExample
e) Щелкните Создать и редактировать.

2. Create a variable: nPromptAnswer:
• Type: Номер
• Name: nPromptAnswer

Create a variable

3. Create a variable: lNumbersForPi:
• Type: Список
• Subtype: Номер
• Name: lNumbersForPi

4. Щелкните Сохранить.
5. Use the Prompt > For value action to ask the user for a number.

a) Click the Show link on the Actions pane.
b) Double-click or drag the Prompt For value action to add it to the bot.
c) In the Prompt window caption field, type: Any Number
d) In the Prompt message field, type: Enter any number to multiply by pi.
e) In the Assign the value to a variable field, select prompt-assignment.

6. Щелкните Сохранить.
7. Use the Error handler > Try action to gracefully end the bot if there was an error, such as the user

not entering a number.
a) Double-click or drag the Error handler > Try action.
b) Drag the Prompt > For value action under the Error handler > Try action.

8. Щелкните Сохранить.
9. Convert the prompt-assignment (string) to a number value.

a) Double-click or drag the String > To number action, adding it as the last line before the Error
handler: Catch action.

b) In the Enter the string field, press F2 to open the list of your variables, and select prompt-
assignment.

c) Click Yes, insert.
d) In the Assign the output to variable field, select nPromptAnswer.

10. Щелкните Сохранить.
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11. Copy the number value to the first item in the list of numbers to pass to VBScript.
a) Double-click or drag the List > Add item action, adding it as the last line before the Error

handler: Catch action.
b) In the List variable field, select lNumbersForPi.
c) In the Item to be added field, select nPromptAnswer.

12. Щелкните Сохранить.
13. Use the VBScript > Open action to provide your Visual Basic source code.

a) Double-click or drag the VBScript Open action, adding it as the last line before the Error
handler: Catch action.

b) In the VBScript options, select Manual Input.
c) Copy the following code and paste it into the Enter script here field:

Dim Arg, var1, var2
Set Arg = WScript.Arguments
Function MultiplyPi(Arg)
  var1 = Arg(0)
  var2 = 3.14159
  MultiplyPi = cdbl(var1)*var2
End Function

14. Щелкните Сохранить.
15. Use the VBScript > Run function action to execute the script.

a) Double-click or drag the VBScript Run function action, adding it as the last line before the
Error handler: Catch action.

b) In the Enter the name of the function to be executed (optional) type MultiplyPi.
c) In the Parameters (optional) field, select lNumbersForPi variable.
d) In the Assign the output to variable (optional) field, select prompt-assignment.

16. Щелкните Сохранить.
17. Use the VBScript > Close action to end the session.

a) Double-click or drag the VBScript Close action, adding it as the last line before the Error
handler: Catch action.

18. Щелкните Сохранить.
19. Print the answer generated in the VBScript on the screen.

a) Double-click or drag the Message box action, adding it as the last line before the Error
handler: Catch action.

b) In the Enter the message to display field, type Pi times your number is: , then press
F2 to open the list of your variables. Select prompt-assignment.

c) Click Yes, insert.

20. Щелкните Сохранить.
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21. Notify the user if an error occurred and end the bot gracefully.
a) Click the Error handler: Catch AllErrors action once so that it is highlighted in your bot.
b) Double-click or drag the Message boxaction to insert it as the last bot action.
c) In the Enter the message to display field, type Bot failed. Please be sure to

 enter only numbers..

22. Щелкните Сохранить.
23. Click the List tab to view your code as text only.

Your code should look like this:

Start
Error handler: Try
    Prompt: For value during bot execution and assign the value $prompt-
assignment$
    String: To number Convert string $prompt-assignment$ to a number and
 assign it to number variable $nPromptAnswer$
    List: Add item $nPromptAnswer$ to $lNumbersForPi$
    VBScript: Open VBScript manual script of 7 lines
    VBScript: Run function "MultiplyPi"
    VBScript: Close VBScript "Default"
    Message box "Pi times your number is: $prompt-assignment$"
Error handler: Catch AllErrors
    Message box "Bot failed.  Please be sure to enter only numbers."
End

24. Run your бот.
25. When the bot runs successfully, a message box displays the calculated number. View the message

and click Close. You can test the resiliency of your bot by running the bot again and entering a letter
instead of a number.

Ссылки, связанные с данной
VBScript пакет
The VBScript пакет contains actions that enable VBScript functions in a task.

Build a Bot Insight dashboard бот
In this example, you build a бот that retrieves data from a website to create visualizations in Bot Insight.
Configure an empty string variable named sNull.
Create a variable

1. Create a new бот:
a) На левой панели щелкните Автоматизация.
b) Щелкните Создать > Бот.
c) In the Create Task Bot window, enter the бот name.
d) Accept the default folder location: \Bots\

To change the default бот storage location, click Choose and follow the prompts.
e) Щелкните Создать и редактировать.
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2. Open a browser window to the web page from which you want to extract the table.
a) Double-click or drag the Browser > Launch website action.
b) In the URL field, enter https://www.statista.com/statistics/183483/ranking-of-

languages-spoken-at-home-in-the-us-in-2008/.
c) Select the Internet Explorer browser.

Прим.:  Use Microsoft Internet Explorer because it reliably launches the website in a new
window, even if another window is already open. Other browsers might launch the website in a
new tab if there is an open window.

d) Щелкните Сохранить.
e) Click Run.

The бот opens the window.

3. Select the table for extraction.
a) Double-click or drag the Recorder > Capture action.
b) Click the Window tab and select the Languages spoken in the United States 2018 |

Statista window from the drop-down list.
If the window title does not appear in the list, click Refresh.

c) Click Capture object.
The Languages spoken in the United States 2018 | Statista window is activated.

d) Hover over the table until an orange box that surrounds the entire table appears.
e) Click the table.
f) Return to the Control Room.
g) In the Object properties table, verify the Control Type is TABLE.

If it is not, click Recapture object.
h) From the Действие drop-down list, select Get table.
i) In the Assign output to variable field, create the tLanguages table variable.

4. Specify the file in which to save the data.
a) Double-click or drag the Data Table > Write to file action.
b) From the Data table name list, select tLanguages.
c) Provide a file path to create a CSV file.

For example, C:\Users\<username>\Desktop\LanguagesTable.csv.
d) Select the Create folders/files if it doesn't exist option.
e) Select to overwrite the existing file.

5. Specify the file that holds the extracted data.
a) Double-click or drag the CSV/TXT > Open action.
b) Provide the file path to the file specified in step 4.
c) Select the Contains header option to exclude the first row.
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6. Iterate though each row of the file.
a) Дважды щелкните или перетащите action Цикл.
b) Select the For each row in CSV/TXT iterator.
c) In the Assign the current row to this variable field, create the variable rCurrentRow.

7. Specify the data to populate the Bot Insight dashboard.
a) Double-click or drag the Analyze > Open action.
b) Double-click or drag the String > Assign action.
c) Enter $rCurrentRow[0]$ as the source string.

Press F2 to open the variables menu.
d) In the Select destination string variable field, create the variable sLanguage.
e) Double-click or drag the String > Replace action.

The extracted data uses commas to separate digits. You must remove the commas before you can
convert the string to a number data type to use in Bot Insight.

f) Enter $rCurrentRow[1]$ as the source string.
Press F2 to open the variables menu.

g) Enter , in the Find string field.
h) Select the Not a regular expression option.
i) In the Replace with field, enter $sNull$.
j) In the Assign the output row to variable field, create the variable sPopulation.
k) Double-click or drag the String > To number action.
l) Введите переменную $sPopulation$.
m) In the Assign the output row to variable field, create the variable nPopulation.
n) Double-click or drag the Analyze > Close action.
o) Select the following variables:

• sLanguage
• nPopulation

8. Click Save and then Run.
9. Click Analyze.

The Bot Insight window appears.

Learn more about dashboards.

Информационные панели Bot Insight

Ссылки, связанные с данной
Analyze пакет
Use the actions in the Analyze пакет to specify the actions and variables to use in the Bot Insight
dashboard and widgets. The Analyze пакет enables you to perform transactional analytics for the data
that is logged by the variables when the бот runs.
Браузер пакет
пакет Браузер содержит actions, которые позволяют загружать файлы, находить неработающие
ссылки и запускать веб-сайт. Этот пакет поддерживает браузеры Google Chrome, Microsoft Edge на
базе Chromium и Internet Explorer.
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Пакет Средство записи
Средство записи пакет захватывает серию задач в ходе их выполнения, а затем автоматизирует
их. Вы можете автоматизировать работу своих бизнес-приложений (например, настольных и
веб-приложений, приложений SAP и Java) с помощью функции Средство записи для записи
actions, выполняемых с объектами приложений, например с текстовым полем, кнопкой, таблицей,
переключателем, комбинированным полем и представлением списка.
Таблица данных пакет
The Таблица данных пакет contains actions that enable you to perform various operations on the values
of table variables. Use these actions to join or merge content, search for specific values, insert rows and
columns, remove duplicate rows, and write values to a file.
CSV/TXT package
The CSV/TXT package contains actions that enable you to open a CSV or text file, read data from that
file, and assign the data to a Table variable. This package supports files encoded in ANSI, Unicode, UTF-8,
or Windows-1251, and can process up to one million records.
Цикл пакет
Use the Цикл package to run a sequence of actions repeatedly for a specific number of times or until a
specific condition is met.

Example of using multiple analyze actions in a task
Build a бот that uses multiple Open and Close Analyze actions in a task to analyze and compare the sales
data for each quarter of XYZ Company, and create visualizations in Bot Insight.
Before you start building the бот, create the following data set on your desktop in the .csv file format.

PRODUCTCODEPRODUCTLINECOUNTRYQUANTITY
ORDERED
QTR1

SALES_QTR1QUANTITY
ORDERED
QTR2

SALES_QTR2QUANTITY
ORDERED
QTR3

SALES_QTR3QUANTITY
ORDERED
QTR4

SALES_QTR4

S18_1367Vintage
Cars

USA 39 4808,31 21 2856 50 5907,5 48 4389,12

S18_1367Vintage
Cars

Германия33 3288,78 42 2262,96 30 1746,6 25 2183,25

S18_1367Vintage
Cars

Франция41 2055,74 42 4431,84 34 5375,4 45 2304,45

S18_1367Vintage
Cars

Австралия48 2354,88 33 3423,75 24 1496,64 32 1742,4

S18_1367Vintage
Cars

UK 30 5151 36 3081,24 33 4950,33 29 5176,5

S18_1367Vintage
Cars

Индия 50 3390 45 1702,8 23 4230,62 44 7554,8

S18_1367Vintage
Cars

Япония 28 1801,24 22 995,5 47 6034,33 33 5890,5

S18_1367Vintage
Cars

New
Zealand

43 4818,15 29 1716,22 42 3958,5 27 1879,74

S18_1367Vintage
Cars

Норвегия39 4178,85 46 1528,58 34 3455,76 38 2323,7

S18_1367Vintage
Cars

Швеция 22 1903,22 - - 24 1685,28 23 1643,12
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PRODUCTCODEPRODUCTLINECOUNTRYQUANTITY
ORDERED
QTR1

SALES_QTR1QUANTITY
ORDERED
QTR2

SALES_QTR2QUANTITY
ORDERED
QTR3

SALES_QTR3QUANTITY
ORDERED
QTR4

SALES_QTR4

S18_1367Vintage
Cars

Испания 50 2490,5 - - 29 1254,83 38 4299,7

S18_1367Vintage
Cars

Канада 49 1689,03 - - 36 1194,84 20 2212

S18_1367Vintage
Cars

Австрия 26 2253,68 - - 49 2414,72 26 3206,32

1. Create a бот.
a) Log in to the Control Room as a Bot Creator.
b) На левой панели щелкните Автоматизация.

Отобразится список доступных боты и форм.
c) Щелкните Создать > Бот.
d) Щелкните Создать и редактировать.

2. Open the XYZ sales data.csv file that you created.
a) Double-click or drag the CSV/TXT > Open action.
b) In the Session name field, enter Session 1.
c) Provide the file path to XYZ company sales data.csv.
d) Select the Contains header option to exclude the first row.

3. Create a Record variable as Row by using the Create variable icon.
The Record variable holds all the values for one row. With each iteration of the loop, the бот retrieves
the values of the next row and stores them in the Record variable, overwriting the values from the
previous row.

4. To retrieve the values in the cells from each row in the XYZ company sales data.csv file, use a
Loop action.
a) Select For each row in CSV/TXT iterator.
b) In the Session name field, enter Session 1.
c) In the Assign the current row to this variable field, select the Row variable that you created.
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5. Create the following variables for four quarters by using the Create variable icon at the top of the
Variables menu.
• PRODUCTCODE
• PRODUCTLINE
• COUNTRY
• QUANTITYORDERED_QTR1
• SALES_QTR1
• QUANTITYORDERED_QTR2
• SALES_QTR2
• QUANTITYORDERED_QTR3
• SALES_QTR3
• QUANTITYORDERED_QTR4
• SALES_QTR4
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6. Specify the data to populate on the Bot Insight business dashboard.
a) Double-click or drag the Analyze > Open action.

Прим.:  Ensure that you insert the Analyze Open and Close actions inside the Loop action to
analyze and capture the data from each row in the Bot Insight dashboard.

b) Double-click or drag the String > Assign action.
Press F2 to open the variables menu.

c) Choose the Row variable from the drop-down list.
d) Enter PRODUCTCODE and click Yes, insert.
e) In the Select destination string variable field, choose the PRODUCTCODE variable.

To assign string variables for PRODUCTLINE and COUNTRY, repeat Step 6b through Step 6e.
f) Double-click or drag the Number > Assign action.

Press F2 to open the variables menu.
g) Choose the row variable from the drop-down list.
h) Enter QUANTITYORDERED_QTR1 and click Yes, insert.
i) In the Select destination string variable field, choose the QUANTITYORDERED_QTR1

variable.
To assign number variables for SALES_QTR1, QUANTITYORDERED_QTR2, SALES_QTR2,
QUANTITYORDERED_QTR3, SALES_QTR3, QUANTITYORDERED_QTR4, and SALES_QTR4, repeat
Step 6f through Step 6i.

j) Double-click or drag the Analyze > Close action.
k) Enter the Transaction name as Quarters 1 and 2.
l) Select the following transactional variables in the Close action:

• PRODUCTCODE
• PRODUCTLINE
• COUNTRY
• QUANTITYORDERED_QTR1
• SALES_QTR1
• QUANTITYORDERED_QTR2
• SALES_QTR2

m) Double-click or drag the Analyze > Open action.
n) Double-click or drag the Analyze > Close action.
o) Enter the Transaction name as Quarters 3 and 4.
p) Select the following transactional variables in the Close action:

• PRODUCTCODE
• PRODUCTLINE
• COUNTRY
• QUANTITYORDERED_QTR3
• SALES_QTR3
• QUANTITYORDERED_QTR4
• SALES_QTR4

7. Click Save and then Run.
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8. Click Analyze Task Bot.
The Bot Insight business dashboard appears.

9. Select the Preview option.
The sales data is displayed as follows:

Example of updating default пакет version across боты
In this example, learn how to perform a bulk update of existing боты in the Control Room repository to
use the default version of the Расширенный Excel пакет.
To update боты to the default пакет version, ensure you have the View пакеты permission and the
permission to edit боты. When you update боты to the default пакет version, all the боты using the
Расширенный Excel пакет in the public workspace for which you have access will be updated to the
default version.
Consider the scenario where there are three versions of the Расширенный Excel пакет (5.0.0XXXXXXX,
 6.7.0XXXXXXX, and 6.8.0XXXXXXX), and the боты created initially are using the Excel default
version of 6.7.0XXXXXXX. The default Расширенный Excel version has to be changed to 6.8.0
 XXXXXXX.
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In this example, you set the default пакет version to 6.8.0XXXXXXX so that all public repository боты
you have access to and which use the Расширенный Excel пакет are updated to use the default version
6.8.0 XXXXXXX.
1. To update all the боты in the public repository that use Расширенный Excel пакет to version

6.8.0XXXXXXX, perform these steps:
a) Navigate to Manage > Пакеты.
b) Search for and open the Расширенный Excel пакет.
c) On the пакет page, click the Version field and choose the version 6.8.0XXXXXXX.
d) Click Update bots to default version.
e) On the Update bots to default package version window that opens, enter the following

information:
• Имя действия: Update Package_Excel_MS_6.8.0.
• Описание: Bulk update of bots to set the default package version

 Excel_MS_6.8.0
• Комментарии о загрузке: Update the Excel advanced package version with

 default version 6.8.0.

f) Щелкните Обновить боты.

The боты are checked out to set the пакет default version as 6.8.0XXXXXXX.
2. Перейдите в раздел Администрирование > Журнал аудита.
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3. On the Audit log page, search by event type and choose the value Update default package.
You can view information about the start of the requested process, individual боты that are being
updated with the default пакет version, and the completion of the requested process.
a) Click the Update default package to bot requested item name and view the following

information:
• Имя запроса: UpdatePackage_Excel_MS_6.8.0 XXXXXXX
• What changed: Package version
• Имя пакета: Excel_MS
• Package version: 6.8.0XXXXXXX

You can view all the боты that are updated to use the default пакет version 6.8.0XXXXXXX.
b) Copy the Request ID , for example, b8bfa7bc58a784e4 from the Update default package

to bot requested page.
c) On the Audit log page, search by filter Request ID and enter the value b8bfa7bc58a784e4.

The Audit log page displays all the боты that are either successfully updated or those that failed
the update process. See the following example image:

d) Click any бот, for example, FineTune RoomDim037 to view the following details:
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• Имя пакета: Excel_MS
• Старая версия пакета: 6.7.0XXXXXXX
• Версия целевого пакета: 6.8.0XXXXXXX
• Старая версия бота: 2
• Новая версия бота: 3

The bulk update process in this case takes approximately 13 minutes because the Control Room
has 500 боты to update.

e) Click the item name Update default package to bot completed to view the following details:
• Имя запроса: UpdatePackage_Excel_MS_6.8.0XXXXXXX.
• Successful bots: 500
• Unsuccessful bots: 0
• What changed: Package version
• Имя пакета: Excel_MS
• Старая версия пакета: N/A

Example of using JSON пакет actions in a бот
Build a бот that runs a JSON script with multiple records. In this example, we use a JSON file that contains
a list of feeds from a blog, and the бот extracts the required information from the JSON file and prints it to
a message box.
To run JSON script from Automation 360, you must already have the JSON data stored either as a variable
or a file (.json, .txt format) on your desktop. The following screenshot displays the structure of a JSON
object as a sample.

{
    "feeds": [
 
        {
            "id": 1090,
            "title": "Amsterdam Beaches",
            "description": "It’s true that few people think of the
 Netherlands when planning a beach holiday. But whether you’re just visiting
 or lucky enough to call this iconic city home, there are plenty of great
 beaches to enjoy in Amsterdam",
            "location": "Kloveniersburgwal 1, 1012 CW Amsterdam,
 Netherlands",
            "lng": 0,
            "lat": 0,
            "userId": 3043,
            "name": "Ritu singh",
            "isdeleted": false,
            "profilePicture": "/Images/userimageicon.png",
            "videoUrl": null,
            "images": null,
            "mediatype": 0,
            "imagePaths": null,
            "feedsComment": null,
            "commentCount": 3,
            "multiMedia": [
                {
                    "id": 2157,
                    "name": "beach of amsterdam.PNG",
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                    "description": null,
                    "url": "feedsmedia/3043/c5522956-4ab5-408e-
b540-16a8c90af9b0.PNG",
                    "mediatype": 1,
                    "likeCount": 0,
                    "place": null,
                    "createAt": "0001-01-01T00:00:00"
                }
            ],
            "likeDislike": {
                "likes": 2,
                "dislikes": 1,
                "userAction": 2
            },
            "createdAt": "2019-12-26T07:08:38.4659686",
            "code": 0,
            "msg": null
        }
  ],
    "totalFeed": 125
}

1. Create a бот.
a) На левой панели щелкните Автоматизация.

Отобразится список доступных боты и форм.
b) Click Create New > Bot.
c) Provide a name for the бот: JsonBot.
d) Щелкните Создать и редактировать.

2. Start a JSON session by using the JSON > Start session action.
a) From the Actions pane, double-click or drag the JSON > Start session action.
b) In the Data Source field, choose File and select the Desktop file file type. Click Browse to

find your JSON file, for example, D:\userdefined\My Downloads\Sample Json with
 200 Records.json.

c) To create a JSON session, from Json object session, select Local session and enter Default
as the session name.

3. Create a variable: SampleString

• Тип: String
• Name: SampleString
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4. Retrieve the value of the total number of feeds from the JSON script by using the JSON > Get node
value action.
a) From the Actions pane, double-click or drag the JSON > Get node value action.
b) In the JSON node key or path field, enter totalFeed.
c) In the Session name field, enter Default.
d) In the Save the outcome to a variable field, select SampleString.
e) To print the value of totalFeed, double-click or drag the Message box action.
f) To open the list of your variables, in the Enter the message to display field, press F2, and then

select SampleString.
g) Click Yes, insert.

5. To retrieve any specific value from 125 feeds, perform the following steps.
a) From the Actions pane, double-click or drag the JSON > Get node value action.
b) In the JSON node key or path field, enter feeds[52].title.
c) In the Session name field, enter Default.
d) In the Save the outcome to a variable field, select SampleString.
e) To print the value of feeds[52].title, double-click or drag the Message box action.
f) To open the list of your variables, in the Enter the message to display field, press F2, and then

select SampleString.
g) Click Yes, insert.
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6. Create a variable: StringList

• Тип: Список
• Subtype: String
• Name: StringList

7. To retrieve the list of child nodes from a node path, use the JSON > Get node list action.
a) From the Actions pane, double-click or drag the JSON > Get node list action.
b) In the JSON node key or path field, enter feeds.
c) In the Session name field, enter Default.
d) In the Save the outcome to a variable field, select StringList.
e) To print all the child nodes under the feed 51 object, double-click or drag the Message box

action.
f) To open the list of your variables, in the Enter the message to display field, press F2, and then

select StringList[51].
g) Click Yes, insert.

8. To close a JSON session, use End session. In the Session name field, enter Default.
9. Click Save and then click Run.
10. Start a new JSON session.

a) From the Actions pane, double-click or drag the JSON > Start session action. In the Data
Source field, select Text and enter StringList[52].

b) From Json object session, select Local session and enter Default 1 as the session name.
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11. To retrieve the value from a specific node, use JSON > Get node value.
a) From the Actions pane, double-click or drag the JSON > Get node value action.
b) In the JSON node key or path field, enter description.
c) In the Session name field, enter Default 1.
d) In the Save the outcome to a variable field, select SampleString.
e) To print the value of the description node, double-click or drag the Message box action.
f) To open the list of your variables, in the Enter the message to display field, press F2, and then

select SampleString.
g) Click Yes, insert.

12. To close the JSON session, use End session. In the Session name field, enter Default 1.
13. Click Save and the click Run.

You can further perform operations to extract the required information from the JSON feed and use
the extracted values in your бот. To extract the name value from feed 50 through 60, perform the
following steps.

14. Create a variable: ListItem

• Тип: String
• Name: ListItem

15. To process each item in the list, use the Loop action.
a) Дважды щелкните или перетащите action Цикл.
b) Select the For each item in the list iterator.
c) In the List field, select StringList.
d) Choose the Range option and for the following fields, enter the values provided:

• From Index: 50
• To index: 60

e) In the Assign the current value to variable field, select ListItem.
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16. Start a new JSON session.
a) From the Actions pane, double-click or drag the JSON > Start session action.
b) In the Data Source field, select Text and enter ListItem.
c) To create a JSON session, from Json object session, select Local session and enter Default

 2 as the session name.

17. To retrieve the value from a specific node, use the JSON > Get node value action .
a) From the Actions pane, double-click or drag the JSON > Get node value action.
b) In the JSON node key or path field, enter name.
c) In the Session name field, enter Default 2.
d) In the Save the outcome to a variable field, select SampleString.
e) To print the value of the name node, double-click or drag the Message box action.
f) To open the list of your variables, in the Enter the message to display field, press F2 , and

then select SampleString.
g) Click Yes, insert.

18. Click Save and then click Run.
The name values retrieved from the feeds 50 through 60 are as follows:

Feeds (object) Имя

50 Ashish

51 Sophia

52 Ritu

53 Shivam

54 Navya

55 Faiz

56 Martin

57 Shweta

58 Jagjit

59 Mark

60 Sophia

Example of using a file variable
This бот building example uses a file variable containing employee addresses, and the бот extracts and
prints the required information into a message box.
Depending on the operation you want to perform, you can retrieve variable values from CSV or text files to
build automations. In this example you:
• Create a бот to read the data from the CSV file (addresses.csv)
• Retrieve the address of an employee
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Before you build the бот, you can create the following data sets on your desktop:

Roy Doe 120 Jefferson St. Riverside IT_PROG

Shaun McGinnis 220 Hobo Av. Rocky Point FI_ACCOUNT

Джон Mark 124 Jefferson St. Riverside SA_HEAD

Sophie Tyler 7300 Terrace "At
the Plaza" Rd.

Wells IT_PROG

Stephen Mathew 22 Theressia St. Troy IT_PROG

Anne Ross 9th St. Lexington IT_PROG

1. Create a бот.
a) На левой панели щелкните Автоматизация.

Отобразится список доступных боты и форм.
b) Click Create New > Bot.
c) Enter a name for the бот: Employee Data.
d) Щелкните Создать и редактировать.

2. Create a user defined variable: $varFile$.
3. Use Open action from CSV/TXT пакет and specify the file variable as: $varFile$.
4. Use the Read action to retrieve values from a CSV file (addresses.csv) and insert them into a

Table variable (TableFromCSV) to perform operations with the data values.
5. Use Message Box to print the value of the $TableFromCSV[3][2]$.
6. Click Save and Run

The бот displays the address: 7300 Terrace "At the Plaza" Rd.

Create dictionary type variables
Use Automation 360 to create dictionary type variables using different dictionary subtypes and key value
type parameters.
• Ensure you have access to the Control Room.
• You must have credentials with AAE_Basic permissions.
• Your workstation must be a registered device in the Control Room.

1. Войдите в Control Room.
2. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
3. Click the Create a bot icon.
4. In the Name field, enter DictionaryMapping, and click Create & Edit.
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5. Create four new custom variables:
a) Create a new Dictionary1 variable of Type > Dictionary and Subtype > String, and then click

Apply.
b) Create a new Dictionary2 variable of Type > Dictionary and Subtype > String, select Use as

output, click Add (+) sign, and enter Key and Value as strings, and then click Apply.
c) Create a new Dictionary3 variable of Type > Dictionary and Subtype > Number, click Add

sign, and enter Key as a string and Value as a number, and then click Apply.
d) Create a new Dictionary4 variable of Type > Dictionary and Subtype > Any, click Add sign,

and enter Type > String > Key > Name > Value as a number Type > Datetime > Key >
Date, enter Value for Datetime location, enter Type > Boolean > Key > Result > Value >
True, and then click Apply.

6. In the Actions pane, find Message box. In Enter the message to display, enter F2, and select the
variable Dictionary1 > Dictionary key > Name.

7. Save the бот and run the DictionaryMapping TaskBot.

Понятия, связанные с данным
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.

Automation Anywhere Robotic Interface (AARI)
Automation Anywhere Robotic Interface or AARI provides a simple, front-end interface for users to execute
and interact with боты and applications.
Use AARI from within applications such as Salesforce and within browsers and desktops for end-to-end
process automation across the enterprise by connecting боты in the front and back offices.

Why use AARI

AARI helps you to achieve the following goals:
• Simplify everyday tasks, such as reporting and keeping track of urgent requests.
• Collaborate easily with your team's applications and боты, thereby improving average handle time and

resolution rate, which helps improve customer satisfaction.
• Speed up even the most complex requests by automating escalations and approvals.
• Accelerate return-on-investment owing to minimal investment on infrastructure, training, and set-up

costs for your enterprise.

What you can do with AARI

AARI enables real-time communication between users and боты. By using AARI to automate repetitive
and time-consuming tasks, you can improve customer experience, increase employee productivity, and cut
operational costs for your organization.
The following image illustrates how AARI enhances automation.

© 2023 Automation Anywhere. All rights reserved.     2120



    Automation Anywhere - Сборка

Accessing AARI

AARI provides various interfaces that you can use to connect to business workflows at multiple
touchpoints. Access AARI in the following ways:
• Web browser

Access AARI through a URL to manage front and back office functions, gathering input and approval
from a single interface.

• Рабочий стол
Retrieve and update data with custom forms. Users can view and interact with all data from a single
screen instead of switching between multiple systems.

• Приложения
Execute боты from common enterprise applications such as Salesforce and Google Workspace through
Automation Anywhere pre-built integrations.
• RPA Bots for Salesforce
• RPA Bots for Google Workspace

The following image illustrates the difference in the process flow between AARI on the web and AARI
desktop:
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Понятия, связанные с данным
Using AARI on the web interface
The Automation Anywhere Robotic Interface(AARI) web interface is an intuitive portal and dedicated
workspace for AARI users to create requests, run tasks, and for AARI managers to create manage team
roles and deployment.
Using AARI on desktop
Use Automation Anywhere Robotic Interface (AARI) through your desktop to manage routine tasks such as
validating data, retrieving approvals, and managing escalations through боты.

Using AARI on the web interface
The Automation Anywhere Robotic Interface(AARI) web interface is an intuitive portal and dedicated
workspace for AARI users to create requests, run tasks, and for AARI managers to create manage team
roles and deployment.
AARI on the web interface provides an engaging experience with attended and unattended боты. It gives
you a one-stop place to view and organize your documents and tasks, perform actions, and hand over the
work to боты. In addition, it provides a process-centric approach to deliver automation.

Capabilities

AARI on the web interface helps you in the following ways:
• Start automation from an easy-to-use process catalog.
• Automate long-running workflows across multiple users and боты.
• Handle бот exceptions.
• Train users and reduce errors with guided automation.
• Multitask with humans and боты.
• Monitor and audit attended automation.

AARI on the web helps multiple users to collaborate with боты without disruption and without accessing
your personally identifiable information (PII) data and confidential systems.
The following image illustrates the front-office automation capability:
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Компоненты

AARI on the web interface includes the following components:

Боты The боты automate specific, repetitive, rule-based
tasks.

Форма The form enables humans to invoke and interact
with the боты through the customizable web
interface.

Процесс The process connects the боты and the forms
together. The process contains the logic for
triggering the боты and the forms and coordinating
the flow of data between them.

Запрос The request is an instance of a process. If the
process defines a template of how боты and forms
interact, a request is a specific instance of that
template.

Задача Tasks are the steps that must be performed within a
process. Processes can have two types of tasks:
• Human task: A task that is performed by a

human; a human task is a form.
• Бот task: A task that is performed by a бот.

Review the following image to gain a better understanding of the relationship between these components.
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Architecture

The following images illustrate the architecture of AARI on the web interface:
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Setting up

The following workflow lists how to use AARI on the web interface to automate and manage your tasks:
1. Configure and set up roles

2. Configure processes
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3. Deploy processes

Прим.:  To view the AARI web interface tasks in an interactive visual format, see Get started with AARI.

AARI web interface users
Various users are involved in AARI on the web interface and each user contributes in different ways to help
automate the business requirements.
AARI users are broadly categorized into two types, users who can access the Control Room and users who
have access only to the web interface. Each user's role and responsibilities vary depending on the stage of
the workflow.

Users and their roles

The following table illustrates the relationship between users, roles, and the permissions they have while
using AARI on the web interface.

Пользователь Функция Разрешения

Control Room administrator AAE_Admin Create users with AARI license
and assign roles.

Bot Creator AAE_Basic • Create a process.
• Check in a process.
• Check out a process.
• Run a private process.
• Delete a process.
• Import a process.
• Export a process.

AARI admin AAE_Robotic Interface
Admin

• Configure scheduler user
and allocate Control Room
resources (device pool and
unattended Bot Runner) to a
process in the configuration
setup stage.

• Perform the following
global team and process
management tasks in the
process deployment stage:
• Create, view, and modify

all teams.
• Assign teams to

processes.
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Пользователь Функция Разрешения

Менеджер AARI AAE_Robotic Interface
Manager

• Create and view teams.

Прим.:  Requires the AARI
license.

• Add members to or remove
members from the teams.

• Assign owners to the teams.
• Function as default admin

for the teams they create.
• Request AARI admin

to assign their team to
processes.

Пользователь AARI AAE_Robotic Interface User • Create and access requests.
• Submit and access tasks.

Team roles and permissions

The following table lists the users, and their roles and permissions in an AARI team.

Прим.:  These roles require the AARI license.

Team role Control Room role Team type Разрешения

Shared • Создать
• View all
• Удалить все
• Assign all
• Modify team

Admin AAE_Robotic
Interface Manager

Private • Создать
• View all
• Удалить все
• Assign all
• Modify team

Owner AAE_Robotic
Interface User

Shared • Создать
• View all
• Удалить все
• Assign all
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Team role Control Room role Team type Разрешения

Private • Создать
• View all
• Удалить все
• Assign all

Shared • Создать
• View all
• Удалить
• Assign all

Member AAE_Robotic
Interface User

Private • Создать
• Просмотреть
• Удалить
• Auto-assign

Прим.:  The AAE_Robotic Interface Manager role sets the AARI manager to automatically have an
admin team role.

Пример

Consider two teams, Finance and HR, and their team roles as listed in the following table:

Finance (private) HR (shared)

Пользователь Функция Пользователь Функция

User A Владелец User X Участник

User B Участник User Y Участник

User C Участник User Z Владелец

For any process, keep in mind the following:
• User A can view and delete all the requests created inside the team Finance.
• Users B and C can view and delete only their requests inside the team Finance.
• Users X, Y, and Z can view all the requests but can delete only their request inside the team HR.
• User Z can view and delete all the requests created inside the team HR.

Configure roles for AARI on the web
Configure users and assign them the AARI license and relevant roles and permissions to start using the
web interface.
As AARI is already installed in the Control Room, you do not need to install it separately in the web
interface.
The primary users involved in the configuration stage are as follows:
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• Control Room administrator: The Control Room administrator creates users and assigns AARI roles
(AARI admin, manager, and user) with the AARI licenses.

Создание пользователей для Automation Anywhere Robotic Interface

.
• AARI admin: The AARI admin creates the scheduler user and allocates Control Room resources required

to run a process.
Configure scheduler user for AARI on the web

.

Workflow map: Click the following schematic image to view the AARI workflow in an interactive visual

format:
1. Get started with AARI

Понятия, связанные с данным
AARI web interface users
Various users are involved in AARI on the web interface and each user contributes in different ways to help
automate the business requirements.

Создание пользователей для Automation Anywhere Robotic Interface
Create the Automation Anywhere Robotic Interface (AARI) admin, manager, and users to use the AARI
functionality for business processes. The Control Room admin creates users and assigns the required
system roles.
Ensure that you have purchased the AARI user license for your business users.

Прим.:  These roles are only applicable for the web interface.

1. На локальном компьютере выполните вход в Control Room в качестве администратора.
2. Перейдите в раздел Администрирование > Пользователи.
3. Щелкните Создать пользователя.

Значок расположен в правом верхнем углу таблицы Пользователи.
Отобразится страница Создать пользователя.

4. В разделе Общая информация введите следующие детали пользователя:

Включить пользователя Установите этот флажок, чтобы пользователь
мог немедленно выполнить вход.

Имя пользователя Введите уникальное имя пользователя.
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Описание Необязательно. Введите описание
пользователя.

Имя Необязательно. Введите имя пользователя.
Фамилия Необязательно. Введите фамилию

пользователя.
Пароль Type and confirm a password for the user. Ensure

the password follows any necessary password
policy.

Эл. почта Введите и подтвердите адрес электронной
почты пользователя. Если включен SMTP,
пользователю на этот адрес отправляется
сообщение электронной почты для
подтверждения учетной записи. Щелкните
по URL-адресу в электронном письме,
чтобы выполнить вход в Control Room и
настроить свои учетные данные. На этот адрес
электронной почты будут отправляться все
важные уведомления Control Room.

5. В разделе Выбрать функции выберите одну из следующих функций в столбце Доступные
функции:
Функция Выберите эту функцию

Администратор AAE_Robotic Interface Admin

Manager AAE_Robotic Interface Manager

Пользователь AAE_Robotic Interface User

6. Click the right arrow to move the role to the Selected column.
7. In the Allocate a device license section, select the following:

Функция Действие

Администратор Retain the default None.
The user with administrator role has access to
the Control Room and AARI on the web.

Manager Retain the default None.
You can optionally assign the AARI user license
to create a request, submit tasks, and create and
view teams.
The user with manager role has access to AARI
on the web.

Пользователь Assign the AARI user license. You can also
optionally assign the attended Bot Runner license
to run local боты or use the desktop interface.
The user has access to AARI on the web.

8. In the AARI licenses section, select the AARI user check box.
9. Щелкните Создать пользователя.

В таблице «Пользователь» отобразится новый пользователь. Если включен SMTP, новому
пользователю отправляется сообщение электронной почты с приглашением выполнить вход.
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Configure scheduler user for AARI on the web
You can configure a scheduler user (global scheduler or per-process scheduler) to allocate the Control
Room resources (devices and unattended Bot Runner) to AARI on the web interface. This scheduler user is
a dedicated user who helps in process deployment.
The role assigned to the scheduler user cannot be a shared role with any other user such as Bot Runner or
an admin user. To perform this task, you will use both the Control Room and AARI web interface.
1. Create a scheduler user with a role in the Control Room.
2. Create device pools in the Control Room.

Прим.:  The AARI administrator is the device pool owner, and you must select your custom role
(AARI-pool-scheduler) in Device Pool Consumers.

3. Assign a scheduler user to a process in the web interface.

Create user and assign role
Create a scheduler user and assign custom role to run the AARI process in the web interface.
You must be an AARI administrator to perform this task.
1. Войдите в Control Room как администратор.
2. Navigate to Administration > Roles.
3. Create a custom role.

For example, AARI-pool-scheduler.
Create a role.
a) Set the permissions to View my bots, View packages, Run my bots, and AARI Scheduler.
b) In the Bots tab, select the folders that contain the боты to be run by the AARI scheduler user,

that you want to give access to with run and view permissions. Set the required бот permissions
for the role at the folder level.

c) Select the unattended users in the Run As section.
d) Сохраните изменения.

4. Create a user.
For example, AARI-scheduler-user.

Прим.:  This user does not require any license.

5. Assign the custom role you created to this user.
For example, AARI-pool-scheduler.

Назначение пользователя планировщика процессу в веб-интерфейсе
Вы можете настроить пользователя планировщик (планировщик группы, планировщик для каждого
процесса или глобальный планировщик) для распределения ресурсов Control Room (устройств и
Bot Runner без сопровождения) в AARI через веб-интерфейс. Пользователь планировщика — это
выделенный пользователь, который помогает в развертывании процессов.
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Убедитесь, что вы создали пользователя планировщика и группу устройств.
1. Войдите в веб-интерфейс в качестве администратора AARI.

Кроме того, вы можете перейти к веб-интерфейсу с помощью Control Room, щелкнув ссылку
Страницы настроек на экране Управление > Группы устройств. Вы автоматически
перейдете на экран веб-интерфейса AARI и войдете в систему в качестве администратора AARI.

2. Выберите пользователя планировщика, выбрав один из указанных ниже вариантов.
Процесс AARI использует группу устройств и Bot Runner без сопровождения, настроенные этим
пользователем для каждого развертывания бот.
По умолчанию выбран Глобальный планировщик, если вы не установили Планировщика
для какого-либо процесса.
По умолчанию выбраны указанные ниже параметры.
a. Выбран пользователь планировщика Группа.
b. Пользователь планировщика Процесс выбирается, если не выбран пользователь

планировщика Группа.
c. Пользователь планировщика Глобальный выбирается, если не выбраны пользователи

планировщика Группа и Процесс.

Тип планировщика Шаги

Группа a. Перейдите в раздел Управление >
Процесс.

b. Выберите процесс для настройки
пользователя планировщика.
Откроется страница Редактировать
процесс.

c. Перейдите на вкладку Группа.
d. Выберите пользователя планировщика

из выпадающего меню в поле
Планировщик.
Планировщик процессов выбран по
умолчанию.

e. Щелкните Сохранить.
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Тип планировщика Шаги

Планировщик (планировщик для
каждого процесса)

a. Перейдите в раздел Управление >
Процесс.

b. Выберите процесс для настройки
пользователя планировщика.
Откроется страница Редактировать
процесс.

c. Перейдите на вкладку Развертывание.
d. Выберите пользователя планировщика

из выпадающего меню в поле
Планировщик процессов.
Глобальный планировщик выбран по
умолчанию.

e. Выберите тип Развертывания.
f. Щелкните Закрыть.

Настройка сохраняется автоматически.

Глобальный планировщик a. Перейдите в раздел Управление >
Процесс.

b. Выберите процесс для настройки
пользователя планировщика.
Откроется страница Редактировать
процесс.

c. Перейдите на вкладку Развертывание.
d. Выберите пользователя Глобальный

планировщик из выпадающего меню в
поле Планировщик процессов .
Глобальный планировщик выбран по
умолчанию.

e. Выберите тип Развертывания.
f. Щелкните Закрыть.

Настройка сохраняется автоматически.

Важное замечание:  Если у пользователей планировщика была удалена функция или у них
недостаточно разрешений на доступ к файлу:
a. Администратор Control Room увидит журнал аудита изменений.
b. Администратор AARI увидит сообщение об ошибке для недопустимого планировщика, после

чего должен будет переназначить нового пользователя планировщика.
c. Пользователь AARI увидит сообщение об ошибке процесса.
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Настройка типа развертывания для боты
Вы можете настроить тип развертывания для задач бот. Это определяет, как будут развертываться
боты в процессе. Вы также можете определить соответствие между пользователем, от имени
которого выполняется задача, и устройством.

Это сопоставление поможет справиться с ограничениями, если таковые имеются в вашей
организационной структуре, например с ограничениями для учетных данных, которые требуют
взаимно однозначного сопоставления между устройством и пользователем, от имени которого
выполняется задача.
1. Перейдите в раздел Управление > Процесс.
2. Выберите процесс.
3. Выберите вкладку Развертывание.
4. В поле Тип развертывания выберите один из указанных ниже параметров.

• Предпочтение устройства по умолчанию. В этом случае бот выполняет развертывание
на устройстве по умолчанию пользователя Bot Runner без сопровождения. Если устройство
по умолчанию недоступно, то бот выполняет развертывание на доступном устройстве в
группе устройств. Все пользователи Bot Runner без сопровождения должны иметь либо
одинаковые учетные данные устройства (имя пользователя и пароль), либо разные учетные
данные (имя пользователя и пароль), установленные для всех устройств. Если пароли для
всех устройств разные, то и имя пользователя тоже будет отличаться.

• Запуск в группе устройств. бот выполняет развертывание на доступном устройстве в
группе устройств. Это переопределяет устройство пользователя по умолчанию.

• Запуск только на устройстве по умолчанию. бот выполняет развертывание только
на устройстве пользователя по умолчанию. В этом варианте пользователь Bot Runner
без сопровождения должен владеть устройством по умолчанию. Если устройство
находится в совместном владении пользователя Bot Runner без сопровождения и другого
лицензированного пользователя, устройство не используется, так как считается, что у
пользователя Bot Runner без сопровождения отсутствует устройство по умолчанию. Если
пользователь планировщика имеет несколько пользователей Bot Runner без сопровождения
и у одного из них нет устройства по умолчанию, то при развертывании бот произойдет сбой.

5. Щелкните Закрыть.

Настройка процессов
AARI обеспечивает автоматизации фронт-офиса и бэк-офиса, где пользователь Bot Creator создает
поток операций процесса, в котором участвуют люди и задачи бот, в соответствии с потребностями
вашего бизнеса.
A Bot Creator user can configure a process in the Process Composer in the Control Room. The
Process Composer provides a drag-and-drop interface to help create process flows. Благодаря этому
пользователь может настраивать время выполнения бот. В редакторе также отображаются
корректные данные для пользователей и происходит обмен данными между несколькими группами.

Дизайн процессов

В процессе участвует человек и задачи бот. Процесс включает в себя указанные ниже компоненты.
• Форма для записи, взаимодействие с которой является первым шагом в любом процессе.
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• Последовательность элементов процесса выглядит следующим образом.
• Формы или TaskBots
• Входные и выходные данные, а также мета-переменные для обмена информацией

• Логические условия, такие как Если и Иначе, для внутреннего и условного создания ветвей
процесса.

• Конечные состояния для закрытия каждого запроса, такие как «Выполнено», «Неудачно» и
«Отменено».

Дизайн форм

Пользователь Bot Creator может создать форму и ввести необходимые данные с помощью элементов
формы, которые могут отображаться в веб-интерфейсе. При создании процессов можно добавлять и
удалять действия формы.
Как пользователь, вы можете взаимодействовать с формой только тогда, когда она вам назначена.
Если форма вам не назначена, она неактивна и доступна только для чтения. Чтобы отредактировать
форму, вы можете назначить ее либо себе, либо любому другому участнику группы, который имеет
доступ к процессу. После редактирования формы правопреемник может либо отправить форму, либо
воспользоваться другими вариантами действий. После отправки формы или использования варианта
действия на странице просмотра запроса отображается следующий шаг или задача.
В веб-интерфейсе в форме поддерживаются указанные ниже элементы.
• Флажок
• Date
• Документ
• Выпадающее меню
• Гиперссылка
• Изображение
• Метка
• Число
• Пароль
• Переключатель
• Редактор Rich Text
• Выберите файл
• Таблица
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• Область текста
• Текстовое поле
• Время

Дизайн TaskBots

Пользователь Bot Creator может создать TaskBot, который будет выполняться внутри процесса,
используя входные и выходные переменные. Когда установлен флажок Использовать как вход,
процесс передает данные во входные переменные, а когда установлен флажок Использовать как
выход, процесс получает данные из выходных переменных после выполнения бот.

Поток операций процесса

Следующий рабочий процесс описывает шаги, необходимые для создания процесса AARI и
предоставления к нему доступа в веб-интерфейсе.
1. Создание процесса AARI.

a. Создание TaskBot.
b. Create an AARI form.

2. Check in an AARI process.

Другие задачи

В зависимости от требований, пользователь Bot Creator может выполнять и другие задачи после
создания процесса.
• Если требования были изменены, то пользователь Bot Creator может выгрузить процесс в свою

личную рабочую область и отредактировать его в соответствии с новыми требованиями.
Check out an AARI process.

• Bot Creator может выполнить тестирование процесса до его загрузки, запустив его в личной
рабочей области.
You can run the process either in the public or the private workspace using the Run option in the
Process Composer. боты в личном процессе выполняется на устройстве Bot Creator по умолчанию.
Во время выполнения личного процесса, пользователь Bot Creator может создать запрос, ввести
данные в исходную форму и запустить свой запрос из личной рабочей области. Запросы,
созданные в ходе выполнения личного процесса, могут быть просмотрены только пользователем,
создавшим запрос. Запросы, созданные в ходе выполнения общедоступного процесса, могут быть
просмотрены администратором AARI. Менеджеры и пользователи могут просматривать запросы,
только если у них есть доступ к процессу.
Run an AARI process.

• Получите доступ к процессу из другой Control Room, импортируя или экспортируя процесс.
Например, если процесс был разработан и протестирован в промежуточной среде и теперь готов
к перемещению в производство, его можно экспортировать из промежуточной среды. Также этот
экспортированный процесс можно импортировать в промежуточную среду.
• Импорт процесса AARI.
• Export an AARI process.
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• Если требование становится ненужным, созданный процесс можно удалить.
Delete an AARI process.

Понятия, связанные с данным
AARI web interface users
Various users are involved in AARI on the web interface and each user contributes in different ways to help
automate the business requirements.

Create an AARI form
Create an Automation Anywhere Robotic Interface (AARI) form to provide interaction between humans and
боты. You can enter the required data using form elements that can be rendered in the web interface. You
can add or remove form actions when creating the process.
• У вас должна быть лицензия Bot Creator.
• Вам должна быть присвоена пользовательская функция с разрешением на создание папки.

Forms in AARI can be displayed in two scenarios:
• Case creation: This is the initial form that is displayed when you want to create a new case and enter

the required business data.
• Form step: This form is displayed to show information and prompt for additional inputs.

1. На левой панели щелкните Автоматизация.
Отобразится список доступных  и форм.

2. Click Create new > Form.
3. На странице Создание формы введите имя для новой формы.

По умолчанию формы сохраняются в папке \Bots\. Щелкните Обзор, чтобы изменить папку по
умолчанию.

4. Щелкните Создать и редактировать.
The form builder page appears with a single row Column layout.

5. If you want to delete a row, click the vertical ellipsis in the form layout and click Delete row.
6. Confirm the delete action in the confirmation message.
7. Drag the required element into the form from the Elements panel on the left.
8. Use the Properties panel on the right to update or change the form properties.
9. Щелкните Сохранить.
10. Щелкните Закрыть.

Создание процесса AARI

Задачи, связанные с данной
Example of uploading and downloading file for web
This task is a use case of how to use the Select File element to upload or download files that are passed
in the initial forms in the web interface.

Example of using the Checkbox element dynamically
The Checkbox element in the AARI form enables you to select multiple options in a form during bot
runtime. In this example, use the Checkbox element to generate dynamic options.
You must have a Bot Creator license and be assigned a custom role with create folder permission.
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In this example, we will create a process to register new employee details in the company database. The
initial form contains basic information such as Name, ID, Date of Birth, Gender, and Location. The initial
form has only two options (San Jose and Tokyo) for the Location field. We will make this field dynamic
where during requestion creation, a new location (India) is added for those employees whose ID is in the
100 to 200 range.
1. Log in to the Control Room as a Bot Creator user.
2. Create the initial form.

Create an AARI form.
a) On the left plane, click Automation.
b) Click Create new > Form.
c) Enter the form name employee_register_initial_form.
d) Enter the folder location Bots\Employee Registration.

To change where your form is stored, click Choose and follow the prompts.
e) Щелкните Создать и редактировать.
f) Use the following Elements and Element label in the form.

Элементы Ярлык элемента

TextBox Full Name

Номер ID

Дата Date of Joining

Выпадающее меню Gender

For the Dropdown element, enter Male, Female in the Enter list items separated by
commas field.

g) Щелкните Сохранить.
h) Щелкните Закрыть.

3. Create another form.
a) In the same folder location, click Create new > Form.
b) Enter the form name employee_location.
c) Щелкните Создать и редактировать.
d) Drag the Checkbox element into the form.
e) Enter the name in the Element label field Employee location.
f) Click the plus icon in the Checkbox content field and add the locations San Jose and Tokyo.
g) Щелкните Сохранить.
h) Щелкните Закрыть.

4. Create a new бот.
a) In the same folder location, click Create new > Bot.
b) Enter the бот name dynamic_checkbox.
c) Щелкните Создать и редактировать.
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5. Create the following variables:
• emp_id: Number type; use as input
• emp_location: List type, String subtype; use as output; click the plus and add two values San

 Jose and Tokyo
• emp_dyn_location: String type, add the default value India

The default values are San Jose and Tokyo but if the employee ID falls between 100 and 200, the
location India is selected.

6. Use the If action to configure the conditional statement.
a) Double-click or drag the If action.
b) Select Number from the Condition drop-down list.
c) In the Source value field, insert the variable $emp_id$.
d) Select Greater Than (>) as the Operator.
e) Enter 100 in the Target value field.
f) Click Add condition and select And.
g) Select Number from the Condition drop-down list.
h) In the Source value field, insert the variable $emp_id$.
i) Select Less Than (<) as the Operator.
j) Enter 200 in the Target value field.
k) Щелкните Сохранить.

7. Use the List package into the If container to insert the new location as per the defined condition.
a) Drag the List > Add item action.
b) In the List variable field, select the variable in which to add the list item emp_location.
c) In the Item to be added field, select the variable that contains the value to add

emp_dyn_location.
d) Щелкните Сохранить.
e) Щелкните Закрыть.
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8. Create a new process.
a) In the same folder location, click Create new > Process.

Создание процесса AARI.
b) Enter the process name employee_register.
c) Щелкните Создать и редактировать.
d) Click Start to add an initial form to the process.
e) In the Select initial data form field, browse and select the initial form, that is

employee_register_initial_form.
f) Provide Request title as Employee Registration.
g) Drag the Bot Task into the Process Composer from the Task field.
h) In the Bot Task panel, Element name field, enter a name Location.
i) Enter the Task name Generate location.
j) In the Select Task Bot field, browse and select the bot you created dynamic_checkbox.
k) In the Input values field, select the input variable emp_id.
l) Drag the Human Task into the Process Composer from the Task field.
m) In the Human Task panel, Element name field, enter a name location_form.
n) Enter the Task name Employee location form.
o) In the Select form field, browse and select the form you created employee_location.
p) Click Add button.
q) Specify OK for Button label and Primary for Button style.
r) Select the Feed data into form check box, Employee Location[CheckBoxGroup0].

Set the two variables from the бот as output variables.
s) In the List of options field, select the output variable $Location.output[emp_location]$.
t) In the Default value field, select the output variable $Location.output[emp_dyn_location]$.
u) Щелкните Сохранить.
v) Щелкните Закрыть.

9. Deploy the process.
a) Click Run.

A request is created for the process.
b) Enter the values for the initial form.
c) Щелкните Отправить.

The process deploys and if the employee ID falls between the values 100 to 200, the Employee
location field will have a new option of India making this option dynamic. If the employee ID is not
between the values 100 to 200, the Employee location field will have only two options, San Jose and
Tokyo.

Example of uploading and downloading file for web
This task is a use case of how to use the Select File element to upload or download files that are passed
in the initial forms in the web interface.
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• You must have a Bot Creator license and be assigned a custom role with the create folder permission.
• Ensure you have access to the Рабочая область RPA.
• You must be provided a system-created AAE_Robotic_Interface User role with the AARI user

license, for the AARI user.
• Ensure you have access to the web interface.

1. Log in to the Рабочая область RPA as a Bot Creator
2. Create a form where the file can be accessed. Create a form to view documents.
3. Create a бот that can call and store the input file. Create a bot with Get Storage file acton.
4. Create a process that allows users to run the бот and access the file. Create a process to select a file

input.
5. Run the process and access the file. View uploaded file.

Create a form to view documents
Create a form to upload files and view documents.
1. Create a new form.

Let's name this form as File Form.
The new form window appears for you to design your form.

2. Drag and drop the Select File element into your form designer from the Elements column.
The Properties - Select File window now appears with relevant fields.

3. Specify a label in the Element label field.
For example: the element label is Select a file (PDF).

4. Specify the supported file format in the Enter supported file formats separated by commas
field.
In this case we would specify PDF.

5. Click Save and close the current window.
6. Create another form.

Let's name this form as View Document Form.
7. Drag and drop the Document element into your form designer from the Elements column.

Use the Image element, instead of the Document element, to add an image to your form.

Прим.:  This works the same way as the Document element. File size should not exceed 150kb (like
a logo image) and supported file types are PNG, JPG, JPEG and GIF.

8. Optional: you can specify the window formatting and dimensions in the Properties - Document
window that appears.

9. Click Save and close the current window.
You have now successfully created a form with the Select File and Document element.
For your next steps on creating a бот, see Create a bot with Get Storage file acton.

Create a bot with Get Storage file acton

1. Create a new бот.
Let's name this bot as Bot File.
The new bot window appears for you to create a bot.

2. Select the plus (+) icon in the Variables field.
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The Create variable window appears.
3. Select File in the drop-down menu in the Type field.
4. Specify the variable name in the Name field.

Let's name this variable as FileVar.
5. Select only the Use as input.
6. Click Create.
7. Drag the Get Storage file action from the AARI Web command.

The AARI Web Get Storage file window appears.
8. Select Variable.
9. Select the FileVar that you had created.
10. Specify the path in the Full path of file in local device to be saved to field.

Важное замечание:  The full path of the file includes the name of the file (ex: C:\aari\output
\filename.pdf).

11. Щелкните Сохранить.
You have successfully created a бот with the Get Storage file action.
For your next steps on creating a process, see Create a process to select a file input.

Create a process to select a file input
Create a process to select a file input.
1. Create a new process.

Let's name this process Process To Download File.
The Process Composer appears for you to create a process.

2. Click on Process entry.
The Start window appears.

3. Click Browse in the Select inital data form field
4. Set the initial form as File Form that you had created.
5. Specify the request title and task name.
6. Click Save and close the current window.
7. Drag and drop the Bot Task into your Process Composer from the Task field.

The Task: Bot Task window appears.
8. Specify your element and task name in the Element name and Task name fields.
9. Select your input value as the FileVar that you had created.
10. Click Save and close the current window.
11. Drag and drop the Human Task into your Process Composer from the Task field.

The Task: Human Task window appears.
12. Specify your element and task name in the Element name and Task name fields.
13. Select the Auto-assign this task to option.
14. Select the View Document Form in the Select Form field that you had created.
15. Click Add button option.
16. Specify your button labels and style Button label and Button style fields.
17. Select Document in the Feed data into form field.

Alternatively, select Image, if you had used the Image element instead.
18. Click Save and close the current window.
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You have successfully created a process to view files.
For your next steps to upload a file, see View uploaded file.

View uploaded file
Run your process and upload a file to view.
1. Click Run to run your process from the Process Composer.

The initial form window for the Process To Download File process appears with the Select a file
(PDF) option for you to upload a file.

2. Click browse to select a PDF file in the initial form.
You have uploaded your file to the initial form.

Важное замечание:  File size is limited to 50MB.

3. Щелкните Отправить.
The request view page appears and the tasks are running.
One of the process steps will show you a preview of the file that was uploaded.

4. Click Done to confirm.
The PDF file is downloaded to the local machine at the file path you set.

5. Navigate to folder on your local machine (e.g. C:\aari\output) where you had specified the file
path.
The downloaded file should now appear in the folder location.

6. Click the PDF file to view your file.
You have succesfully uploaded a file and viewed that file.

Cloud storage usage
This topic describes the cloud storage based on the file size that is uploaded by the user.

Обзор

Users who use the Select File element are able to upload files, these files are stored on the cloud and
have specific requirements.
Cloud Storage quota
The files that are uploaded by users are based on the maximum file and storage sizes.
The quota for cloud storage are as follows:
• The file size for when the user uploads a file using the Select File element cannot exceed 50 MB.

Важное замечание:  The file limit is only attached to a Select File element and not a request. In
addition, you can only upload one file for each Select File element, however, there is no limit to the
number of Select File elements that can be added to a form.

• The cloud storage can store a maximum of 250 MB of data per tenant.

Прим.:  This is set by default. The storage limit is per tenant and not per user.

• The storage for each tenant is extended to an additional 1 GB for every AARI user license that are
allocated in the tenant.
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Важное замечание:  These storage restrictions is only applied to the process when used for AARI
use cases. However, there are no storage capacity restrictions for AARI Assistant storage and use cases.

Retention Policy
There is a retention policy for files that are uploaded to the cloud storage.
The retention policy are as follows:
File will be deleted 90 days after the time of the file upload.
When a request is deleted, the request and the associated file are permanently deleted and not just sent
to the recycle bin.

Прим.:  This is supported only for requests with one associated file, not multiple files.

Example of uploading a file as a request input
This is an example of using forms to upload and view a PDF file.
1. You must have a Bot Creator license and be assigned a custom role with the create folder permission.
2. Ensure you have access to the Рабочая область RPA.
3. You must be provided a system-created AAE_Robotic_Interface User role with the AARI user

license, for the AARI user.
4. Ensure you have access to the web interface.

1. Log in to the Рабочая область RPA as a Bot Creator
2. Create a form with the Select File element.

This is your first form.
3. Create a form with the Document element.

This is your second form.
4. Create a process to view files.

Now that you have created a process with data from two forms, you can now run your process.
5. Click Run in the Process Composer.

The initial form will now open in a separate tab for you to interact.
6. Click browse to select a file.

You need to navigate to the file path in your local machine.
7. Select a PDF file.

Важное замечание:  File size is limited to 50MB.

8. Click Open.
You should now be able to open that PDF file in your form.

9. Щелкните Отправить.
10. Click Done to confirm.

The PDF file is successfully uploaded.
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Create a form with the Select File element
You can create a form with the Select File element to select files.
1. Create a new form.

Let's name this form as Select File Form.
2. Drag and drop the Select File element into your form designer from the Elements column.

The Properties - Select File window now appears with relevant fields.
3. Specify a label in the Element label field.

This can be labeled as Upload a file.
4. Specify the supported file format in the Enter supported file formats separated by commas

field.
You can specify PDF.

5. Click Save to save your form session.
6. Click Close to close the current form window.

Create a form with the Document element
You can create a form with the Document element to select files.
1. Create a new form.

Let's name this form as Document Viewer Form.
2. Drag and drop the Document element into your form designer from the Elements column.

The Properties - Form window now appears with relevant fields.
3. Необязательно. You can modify your document dimensions or keep the system default settings.
4. Click Save to save your form session.
5. Click Close to close the current form window.

Create a process to view files

1. Create a new process.
Let's name this process View a File Process.
The Process Composer appears for you to create a process.

2. Click the Start node (green icon).
This is the first node of your process entry.
The Start window now appears with relevant fields.

3. Click the Browse option in the Select initial data field to search for a form.
4. Click the Browse tab in the Find a form window.
5. Select the Select File Form that you had created.

This is your first form.
6. Click Choose to confirm.
7. Specify the title in Request title field.

You can name the title as Select File or similar.
Leave the rest of the entries as is.

8. Щелкните Сохранить.
9. Drag and drop the Human Task from the Task column to your process work flow.

The Task: Human Task window appears.
10. Specify your element name in the Element name field.
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You can name the title as File or similar.
11. Click the Browse option in the Select form field to search for a form.
12. Click the Browse tab in the Find a form window.
13. Select the Document Viewer Form that you had created.

This is your second form.
14. Click Choose to confirm.
15. Specify your button details in the Add form button field.

You can specify Upload as the Button label and keep the Primary setting as the Button style.
16. Select the Document[Document0] option in the Feed data into form field.

This will show up as a check mark your selected option.
17. Click Insert a variable in the blank field.

a) Select Request as your variable source.
b) Select Input as your variable type.
c) Select Upload a file[File0]-File as your variable type.

This option should automatically be define for you to choose.
d) Click Add to add and confirm your variable.

18. Click Save to save your session.

Создание процесса AARI
Создайте поток операций процесса Automation Anywhere Robotic Interface (AARI) для удовлетворения
потребностей вашего бизнеса. You create the process in the Process Composer that incorporates human
and бот tasks.
• У вас должна быть лицензия Bot Creator.
• Вам должна быть присвоена пользовательская функция с разрешением на создание папки.

Прим.:  Each task, logic condition, and end point now supports the copy, paste, and cut elements from
the bot editor. Additionally, you can double-click to add and replace items on the canvas. См. раздел
Behaviors supported in the Process Composer.

1. Создание процесса
a) На локальном компьютере выполните вход в Control Room в качестве Bot Creator.
b) На панели слева щелкните Автоматизация, а затем Создать > Процесс.
c) На странице Создать процесс введите имя для нового процесса.

Процессы сохраняются в папке \Bots\. Щелкните Обзор, чтобы изменить папку по
умолчанию.

d) Щелкните Создать и редактировать.
e) Необязательно. Щелкните имя процесса, чтобы переименовать его.

2. Добавьте исходную форму в процесс, щелкнув Начать.
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3. На панели Начать выполните указанные ниже действия.
a) Просмотрите и Выберите форму исходных данных.
b) In the Request title field, enter any text or insert a variable.

Это входная переменная. Для этого запроса создается динамический заголовок, который
будет отображаться в веб-интерфейсе и будет служить в качестве ссылки.

Прим.:  You can use a Reference ID such as ref ID = $RefId$. Reference ID is a Meta
variable type.

c) In the Task name field, enter the name of the task.
You can use a Reference ID such as task ref ID = $RefId$.

d) Необязательно. In the Data privacy tag field (same as PII tag), enter a text or variable to
generate hidden custom output.

e) Щелкните Применить.

4. Add Bot Task to AARI process.
The Bot Task runs a bot with inputs and outputs.

5. Add Human Task to AARI process.
The Human Task displays a form that requires interactions by a user.

6. Необязательно. Add Filter Task to AARI process.
The Filter task allows you to filter a variable according to your specific criteria.

7. Необязательно. Add Process Task to AARI process.
The Process Task enables for you to run a process.

8. Необязательно. Add Document Validation to AARI process.
The Document Validation Task displays a validator for a document that requires validations.
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9. Добавьте условие в процесс, перетащив условие с панели Элементы.
Вы можете выбрать Пару If/Else или Else if.

10. На панели Условие выполните указанные ниже действия.
a) Необязательно. Добавьте описание в поле Описание.
b) Необязательно. Добавьте сообщение в поле Отобразить сообщение.

Введенное вами сообщение отображается на странице просмотра запроса в
веб-интерфейсе.

c) Щелкните Добавить условие, чтобы добавить условие.
Вы можете выбрать условие из четырех доступных типов: Логический, Дата/время,
Число или Строка.

d) Щелкните Применить.

11. Add an End Point to AARI process.
The End Process ends a process with a selected status while the Go to navigates to another tasks in a
process.
You have now configured your AARI process

12. Необязательно. If you want to preview your бот or forms information in the Process Composer
(Edit process page) in both your public and private workspace, follow these steps.
a) Щелкните вертикальное многоточие рядом с пунктом Задача бота или Задача,

выполняемая человеком.
b) Выберите параметр Предварительный просмотр бота или Предварительный

просмотр формы.
В общей рабочей области эти параметры отображают страницу Предварительный
просмотр имени бота или Предварительный просмотр имени формы. На этой
странице можно быстро просмотреть бот или форму.
В личной рабочей области эти параметры отображают страницу Редактировать Task Bot
или Редактировать форму, на которой вы можете внести изменения в ваш TaskBot или
форму.

Задачи, связанные с данной
Создание первого бот
Выполните следующие шаги, чтобы создать первый бот, который печатает сообщение (Go be
great!), версия Automation Anywhere Hello World!
Create an AARI form
Create an Automation Anywhere Robotic Interface (AARI) form to provide interaction between humans and
боты. You can enter the required data using form elements that can be rendered in the web interface. You
can add or remove form actions when creating the process.
Ссылки, связанные с данной
About the AARI process in Document Automation
Document Automation uses Automation Anywhere Robotic Interface technology to manage the end-to-end
document extraction process. When you create a learning instance in Document Automation, the system
also creates an AARI process. Review the following guide to understand the logic.

Add Bot Task to AARI process
You can add a Bot Task to configure the settings.
1. Добавьте Задачу бота в процесс, перетащив элемент с панели Элемент.
2. На панели Задача бота выполните указанные ниже действия.

a) Введите имя в поле Название элемента.
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b) Введите название задачи в поле Название задачи.
Название отображаемой задачи представлено в веб-интерфейсе в качестве ссылки. You can
use a Reference ID such as ref ID = $RefId$.

c) Необязательно. Установите флажок Скрыть эту задачу после завершения.
После выполнения задачи Задача бота не будет отображаться для пользователя в
веб-интерфейсе.
Чтобы отобразить скрытую задачу, установите флажок Просмотреть скрытые задачи на
странице просмотра задач веб-интерфейса.

d) Просмотрите и выберите TaskBot в поле Выбрать Task Bot.
e) В разделе Запустить бота и зависимости с помощью выберите версию метки.

Вы можете выбрать Последнюю версию (устанавливается по умолчанию) или Метку
«Производство».
бот выполняет развертывание выбранной вами версии.

f) В разделе Приоритет бота выберите уровень приоритета бот.

Прим.:  Уровень приоритета бота — это метка, доступная только для чтения, которая
показывает значение Низкий, Средний или Высокий в зависимости от уровня
приоритета, который был установлен для бот. Ранее для уровня приоритета было
установлено значение Средний для всех боты, но теперь учитывается приоритет бот.

Важное замечание:  If the priority of a task bot was changed, you need to browse for the task
bot again in order to reflect the correct priority status for an existing AARI process.

g) Необязательно. В поле Тег конфиденциальности данных введите текст или
переменную для создания скрытого пользовательского вывода.
Установите флажок в поле Входные значения и укажите переменную.
Входные значения переменной, ожидаемые бот, сопоставляются с переменной, которая
будет заполнена при создании запроса.
1. Выберите задачу в поле Задача процесса.
2. Выберите тип в поле Тип переменной.

Вы можете выбрать Ввод, Вывод или Мета.
См. раздел AARI variable types.

3. Укажите вашу переменную в поле Переменная.

Прим.:  Reference ID is a Meta variable type.

4. Щелкните Применить.

3. Щелкните Сохранить.
You have now configured the Bot Task in your AARI process.

Add Human Task to AARI process
You can add a Human Task to configure the settings.
1. Добавьте Задачу, выполняемую человеком в процесс, перетащив элемент с панели

Элемент.
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2. На панели Задача, выполняемая человеком выполните указанные ниже действия.
a) Введите имя в поле Название элемента.
b) Введите название задачи в поле Название задачи.

Название отображаемой задачи представлено в веб-интерфейсе в качестве ссылки. You can
use a Reference ID such as ref ID = $RefId$.

c) Установите флажок Скрыть эту задачу после завершения.
После выполнения задачи Задача, выполняемая человеком не будет отображаться для
пользователя в веб-интерфейсе.
Чтобы отобразить скрытую задачу, установите флажок Просмотреть скрытые задачи на
странице просмотра задач веб-интерфейса.

d) Установите флажок Сделать форму доступной только для чтения.
Задача, выполняемая человеком не требует ввода данных и автоматически переходит к
следующей задаче.

e) Установите флажок Назначить эту задачу пользователю, который создал этот
запрос.
Задача автоматически назначается пользователю, создающему этот запрос в
веб-интерфейсе.

f) Установите флажок Автоматически назначить эту задачу. В раскрывающемся списке
можно выбрать указанные ниже параметры.
• Пользователь, создавший запрос. Задача автоматически назначается пользователю,

создающему запрос в веб-интерфейсе.
• Пользователь, открывающий эту задачу. Задача автоматически назначается

пользователю, который открывает задачу в веб-интерфейсе.

g) In the Task expiration time field, select the time option.
You can choose from among the following options: No expiration (default), 1 hour, 1 day, 1
week, 2 week, 30 days, and Custom.

Прим.:  If you choose the Custom option, you must specify the time by the number of days,
hours, and minutes. The maximum is 45 days, and the minimum is 1 minute. Days range from
0 to 45 days, and hours range from 0 to 23 hours. For minutes, if the hours and days are set to
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0, minute range is 1 to 59 minutes. However, if the hours and days are not set to 0, minute range
is 0 to 59 minutes.

h) В поле Выбрать форму найдите и выберите вторую созданную форму.
В этой форме отображается результат.

i) В поле Тег конфиденциальности данных введите текст или переменную для создания
скрытого пользовательского вывода.

j) В поле Добавить кнопку формы укажите сведения о кнопке.
• Укажите имя в поле Ярлык кнопки.
• Выберите стиль в поле Стиль кнопки.

Можно выбрать параметр Основная, Второстепенная или Отменить.
• Щелкните Добавить кнопку чтобы добавить дополнительные кнопки.

k) Установите флажок в поле Ввести данные в форму.
1. Выберите задачу в поле Задача процесса.
2. Выберите тип в поле Тип переменной.

Вы можете выбрать Ввод, Вывод или Мета.
3. Укажите вашу переменную в поле Переменная.

Прим.:  Reference ID is a Meta variable type.

4. Щелкните Применить.
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3. Щелкните Сохранить.
You have now configured the Human Task in your AARI process.

Add Filter Task to AARI process
You can add a Filter Task to configure the settings.
1. Добавьте параметр Задача фильтрации в процесс, перетащив элемент с панели Задача.

Задача фильтрации применяет фильтр к переменной процесса.
Пример. У вас есть таблица в качестве выходных данных формы, и эти выходные данные
включают в себя столбец Одобрено, строки которого содержат значения Да или Нет. Задача
фильтрации сможет извлекать только строки со значением Да в качестве выходных данных
задачи фильтрации.

2. На панели Задача фильтрации выполните указанные ниже действия.
a) Введите имя в поле Название элемента.
b) Введите название задачи в поле Название отображаемой задачи.

Название отображаемой задачи представлено в веб-интерфейсе в качестве ссылки.
c) Необязательно. Установите флажок Скрыть эту задачу.

После выполнения задачи Задача фильтрации не будет отображаться для пользователя в
веб-интерфейсе.
Чтобы отобразить скрытую задачу, установите флажок Просмотреть скрытые задачи на
странице просмотра задач веб-интерфейса.

d) Введите переменную в поле Переменная для фильтрации.
e) В поле Тип фильтрации выберите нужный параметр.

Например, для переменной словаря доступны параметры Отметить каждую пару
ключ/значение в словаре или Отметить весь словарь.

f) В поле Критерий фильтра выберите условие.
После выбора условия укажите поля Исходная переменная, Оператор и Целевое
значение.

3. Щелкните Сохранить.
You have now configured the Filter Task in your AARI process.

Add Process Task to AARI process
You can add a Process Task to configure the settings.
1. Добавьте параметр Задача процесса в процесс, перетащив элемент с панели Задача.
2. На панели Задача процесса выполните указанные ниже действия.

a) Введите имя в поле Название элемента.
b) Введите название задачи в поле Название задачи.

Название отображаемой задачи представлено в веб-интерфейсе в качестве ссылки.
c) Необязательно. Установите флажок Скрыть эту задачу от пользователей.

После выполнения задачи Задача процесса не будет отображаться для пользователя в
веб-интерфейсе.
Чтобы отобразить скрытую задачу, установите флажок Просмотреть скрытые задачи на
странице просмотра задач веб-интерфейса.

d) Выберите Общедоступную папку или Личную папку, а затем найдите и выберите
процесс.
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e) В поле Тег конфиденциальности данных введите текст или переменную для создания
скрытого пользовательского вывода.

f) Установите флажок в поле Входные значения и укажите переменную.
1. Выберите задачу в поле Задача процесса.
2. Выберите тип в поле Тип переменной.

Вы можете выбрать Ввод, Вывод или Мета.
3. Укажите вашу переменную в поле Переменная.

3. Щелкните Сохранить.
You have now configured the Process Task in your AARI process.

Add Document Validation to AARI process
You can add a Document Validation Task to configure the settings.
1. Add the Document Validtation Task option to the process by dragging the element from the Task

panel.
2. From the Document Validtation Task panel, perform these steps:

a) Введите имя в поле Название элемента.
b) Введите название задачи в поле Название задачи.

The task name appears in the web interface as a reference.
c) Необязательно. Установите флажок Скрыть эту задачу от пользователей.

After task completion, the Document Validtation Task is not displayed to the user in the web
interface.
Чтобы отобразить скрытую задачу, установите флажок Просмотреть скрытые задачи на
странице просмотра задач веб-интерфейса.

d) Необязательно. Установите флажок Автоматически назначить эту задачу. В
раскрывающемся списке можно выбрать указанные ниже параметры.
• Пользователь, создавший запрос. Задача автоматически назначается пользователю,

создающему запрос в веб-интерфейсе.
• Пользователь, открывающий эту задачу. Задача автоматически назначается

пользователю, который открывает задачу в веб-интерфейсе.

e) Specify the ID in the Document ID field.
f) Необязательно. В поле Тег конфиденциальности данных введите текст или

переменную для создания скрытого пользовательского вывода.
Установите флажок в поле Входные значения и укажите переменную.
1. Выберите задачу в поле Задача процесса.
2. Выберите тип в поле Тип переменной.

Вы можете выбрать Ввод, Вывод или Мета.
3. Укажите вашу переменную в поле Переменная.

3. Щелкните Сохранить.
You have now configured the API Task in your AARI process.
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Add an End Point to AARI process
You can add an end point to close your AARI process.
You can add the End point by dragging the End process or Go to from the End point panel to your
process.
• На панели Конечная точка:Завершить процесс выполните указанные ниже действия.

a) Выберите тип в поле Статус конечного процесса.
Можно выбрать параметр Выполнено, Неудачно или Отменено.

b) Необязательно. Укажите имя в поле Обновить заголовок запроса.
c) Необязательно. Добавьте сообщение в поле Отобразить сообщение.

Введенное вами сообщение отобразится на последнем шаге вашей задачи на странице
просмотра запроса.

d) Щелкните Применить.
e) Чтобы сохранить процесс, щелкните Сохранить.

• На панели Конечная точка:Перейти к выполните указанные ниже действия.
a) Укажите задачу для параметра Выбрать целевую задачу, выбрав Задачу бота или

Задачу, выполняемую человеком.
b) Установите флажок Заменить настройку назначения задачи и в выпадающем списке

выберите Отменить назначение задачи или Назначить задачу пользователю,
который создал этот запрос.
В зависимости от вашего выбора назначение задачи будет отменено или пользователь,
создающий запрос, сможет автоматически просмотреть назначенную ему задачу в
веб-интерфейсе.

c) Чтобы сохранить процесс, щелкните Сохранить.

AARI variable types
Data flow (workflow engine) is the core part of a process that moves data between each task. Tasks
require variables in order to run properly and three types of variables are available: input, output, and
meta-type variables.

Variable types

Ввод Users can use this type of variable in the Process
Composer to return values that went “in” a task.

Выходной Users can use this type of variable in the Process
Composer to return values that went “out” a task.

Мета Users can use this type of variable in the Process
Composer to return high-level information about the
request of a task.
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Variable entities

The following entities can hold variables:

Запрос Requests can only hold meta-type variables and
have the following form: $<meta variable
 name>]$

This meta-type variable value is from the request.

Задача Tasks can hold three types of variables (input,
output, meta) and have the following forms:
• $<task>.<input|output>[<variable

 name>]$: This variable value is read from the
task input or output.

• $<task>.<meta variable name>$: This
meta-type variable value is read from the task.

Date time variables

Имя Entities Описание

createdOn Request, Task Shows the date when the request or task was
created.
Пример. $createdOn$ or
$Approval_Task.createdOn$

updatedOn Request, Task Shows the date when the request or task was
last updated.
Пример. $updatedOn$ or
$Approval_Task.updatedOn$

Dictionary variables

Имя Entities Описание

assignedTo Задача Shows information about the user who is
assigned to the task.
Dictionary key: {id}, {username}, {email}

Example: $Approval_Task.assignedTo$

createdBy Запрос Shows information about the user who created
the request.
Dictionary key: {id}, {username}, {email}

Example: $createdBy$
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Number variables

Имя Entities Описание

executionCount Задача Shows the number of times the task was run.
Example: $Name_Bot.executionCount$

id Request, Task Shows the numerical ID of a request or task.
Пример. $id$ or $Approval_Task.id$

assignedTo{id} Задача Shows the numerical ID of the user who is
assigned to the task.
Example: $Approval_Task.assignedTo{id}$

createdBy{id} Запрос Shows the numerical ID of the user who created
the request.
Example: %createdBy{id}$

String variables

Имя Entities Описание

status Задача Shows the label of the button clicked (action) for
a human task or the бот return code for a бот
task (equal to failed when the бот fails).
Пример. %Approval_Task.status$ or
$Name_Bot.status$

title Request, Task Shows the title of the request or task.
Пример. %title$ or %Approval_Task.title$

type Запрос Shows the task type (equal to BOT for бот tasks
and FORM for human tasks).
Example: %Task.type$

assignedTo{username} Задача Shows the username of the user who is assigned
to the task.
Example: $Approval_Task.assignedTo{username}$

createdBy{username} Запрос Shows the username of the user who created
the request.
Example: $createdBy{username}$

assignedTo{email} Задача Shows the email of the user who is assigned to
the task.
Example: $Approval_Task.assignedTo{email}$
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Имя Entities Описание

createdBy{email} Запрос Shows the email of the user who created the
request.
Example: $createdBy{email}$

Use an Output variable
Users can create an output variable that is applicable for any process in order to display the output of a
child process in the parent process.
Once a user has created a process in the Process Composer, they can create an output variable that can
be called in the end process.
• Create an output variable:

a) Navigate to the Output variables section.
b) Click Show.
c) Щелкните по значку «плюс».

The Create variable window appears for your to create a new variable.
d) Specify the name of the variable in the Name field (ex: output).
e) Select your variable type in the Type field (ex: String).
f) Необязательно. Specify the variable information in the Description field.
g) Необязательно. Specify a default variable in the Default value field.

In this step you need to insert a variable.
a. Select a source in the Variable source field (ex: botTask).
b. Select Output as a Variable type option.
c. Select a variable in the Variable field (ex: output).
d. Click Yes, insert to confirm your changes.

h) Click Create.
You have now created a new output variable! This output variable is located in the User-defined
variables in the Output variables section.

• Edit or delete an existing output variable:
a) Navigate to the Output variables section.
b) Select the three dots icon next the user-defined output variable (ex: output).
c) Необязательно. Select the Delete variable to delete the current variable.
d) Select the Edit variable to edit the current variable.

The Edit variable window now prompts for you to add any new changes to your current variable.
e) Click Apply to save your changes.

You have now modified an existing output variable.

Behaviors supported in the Process Composer
Process Composer tasks, logic conditions, and end points now support copy, paste, and cut from the bot
editor. This also includes the ability for users to double-click and to replace items on the canvas.
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Элементы

Копировать Use CTRL + C to copy the data from the task.
Вставить Use CTRL + V to paste the copied data in your

task.
Вырезать Use CTRL + X to copy and remove data from your

task.
Double-click to add Double-click a task to add data to it.

Copy behaviors

When you copy a task in the canvas, these behaviors will occur:

Task types Behavior

• Задача бота
• Задача, выполняемая человеком
• Задача фильтрации
• Document Validation Task
• Если
• Else If
• End process
• Перейти к

Properties are retained in the clipboard.

Else Task is not retained in the clipboard.

Paste behaviors

When you paste a task in the canvas, these behaviors will occur:

Task types Node selected Behavior

• Задача бота
• Задача,

выполняемая
человеком

• Задача
фильтрации

• Document Validation
Task

• Пара If/Else

Нет Task is attached to the last node located before
the end point (End process or Go to).
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Task types Node selected Behavior

• Задача бота
• Задача,

выполняемая
человеком

• Задача
фильтрации

• Document Validation
Task

• Пара If/Else

• End process
• Перейти к

Task is attached to the last node placed before
the end point (End process or Go to).

• Задача бота
• Задача,

выполняемая
человеком

• Задача
фильтрации

• Document Validation
Task

• Пара If/Else

• Задача бота
• Задача,

выполняемая
человеком

• Задача
фильтрации

• Document Validation
• Если
• Else If
• Else

Task is attached to the node.

• End process
• Перейти к

• Задача бота
• Задача,

выполняемая
человеком

• Задача
фильтрации

• Document Validation
• Если
• Else If
• Else
• Нет

Paste is not allowed or disabled.

• End process
• Перейти к

• End process
• Перейти к

Task replaces the selected node.

Else If • Если
• Else If

Task is added as a new Else if node in the same
line as the If or Else if and located in the last
position before the Else.
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Task types Node selected Behavior

Else If • Задача бота
• Задача,

выполняемая
человеком

• Задача
фильтрации

• Document Validation
• Завершить процесс
• Нет

Task is not added to the canvas because this
action is invalid.

Cut behaviors

When you cut a task in the canvas, these behaviors will occur:

Task types Behavior

• Задача бота
• Задача, выполняемая

человеком
• Задача фильтрации
• Document Validation Task

Task is removed from the canvas by deletion but the clipboard
retains task with all the properties .

• Если
• Else If

Task is removed from the canvas by deletion but the clipboard
retains task with all the properties. All child nodes are deleted
from the canvas.

Else Task is not removed or retained in the clipboard.

• End process
• Перейти к

Task is removed from the canvas by deletion but the clipboard
contains task with all the properties.

Double-click to add behaviors
When you double-click to add in the canvas, these behaviors will occur:

Task types Node selected Behavior

• Задача бота
• Задача,

выполняемая
человеком

• Задача
фильтрации

• Document Validation
Task

• Пара If/Else

Нет Task is attached to the last node located before
the end point (End process or Go to) of the
main branch (farthest left).
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Task types Node selected Behavior

• Задача бота
• Задача,

выполняемая
человеком

• Задача
фильтрации

• Document Validation
Task

• Пара If/Else

• End process
• Перейти к

Task is attached to the last node located before
the end point (End process or Go to).

• Задача бота
• Задача,

выполняемая
человеком

• Задача
фильтрации

• Document Validation
Task

• Пара If/Else

• Задача бота
• Задача,

выполняемая
человеком

• Задача
фильтрации

• Document Validation
• Если
• Else If
• Else

Task is attached to the selected node.

• End process
• Перейти к

• Задача бота
• Задача,

выполняемая
человеком

• Задача
фильтрации

• Document Validation
• Если
• Else If
• Else
• Нет

Double-click is not allowed or disabled.

• End process
• Перейти к

• End process
• Перейти к

Task replaces the selected node.

Else If Если Task is added as a new Else if node in the same
line as the If or Else if and in the last position
before the Else.
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Task types Node selected Behavior

Else If • Задача бота
• Задача,

выполняемая
человеком

• Задача
фильтрации

• Document Validation
• Else If
• Завершить процесс
• Перейти к
• Нет

Task is not added to the canvas because this
action is invalid.

Delete an AARI process
As an AARI administrator or a user with Delete from Public permission, you can delete an AARI process
in the public workspace.
While deleting a process, keep the following considerations in mind:
• You can delete processes that have open requests.

After a process is deleted, you cannot access the process even if the requests still exist. The scheduled
боты can still be executed, but the forms cannot be submitted. If you republish the same process, the
old requests can be restored and team permissions can be created again.

• You cannot delete checked-out processes.

1. Log in to the Control Room as an AARI administrator or a Bot Creator user.
2. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
3. Select the process you want to delete, open the actions menu (vertical ellipsis), and click Delete

process.
You must first delete the process in order to delete the боты or forms within the process.

4. Select Yes, delete to confirm.
When the process is deleted from the public workspace, it is removed from the process management
page in the web interface. Additionally, if the process is already assigned to any AARI user or team,
access is removed after the process is deleted from the public workspace.

Run an AARI process
In the Control Room, as a Bot Creator, you can run a process from the Process Composer in the private
workspace.
Keep in mind the following considerations:
• When the process is executed in the private workspace, the Bot Creator can create a request and enter

data in the initial form.
In the private workspace, the боты are executed on the default device of the Bot Creator.
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• Requests created from the private workspace can be viewed only by the user creating the request.
The AARI administrator cannot view the processes executed from the private workspace in the process
management page.

1. Log in to the Control Room as a Bot Creator user.
2. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
3. Click the process name.
4. When the process opens in the Process Composer, click Run .

A window opens, where you are prompted with the initial form.

Check in an AARI process
Check in an Automation Anywhere Robotic Interface (AARI) process to the public workspace from the
private workspace to make it available for other users.
• У вас должна быть лицензия Bot Creator.
• You must be assigned a custom role with the following permissions:

• Required: Check-in and check-out permission
• Необязательно. Create folder permission
• Необязательно. View packages permission

• To check in a process with dependent folders and files, ensure you have the following:
• Create folder permission.

If you are checking in a process from your private workspace and if the folder in which the process
is present does not yet exist in the public workspace, you must have the create folder permission to
successfully check in the process.

• Check-in permission on the dependency folder.

Важное замечание:  If a бот is checked out, edited, and checked in again, the changes to the
бот are reflected immediately. Whereas, if you do the same for forms, the changes to forms are only
reflected when the entire process is checked in again.

1. Log in to the Control Room as a Bot Creator user.
2. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
3. Select the process you want to check in, open the actions menu (vertical ellipsis), and click Check in

process.
4. In the Check in Process window, add your comment and click Check in.

The process appears in the same folder structure in the public workspace.

Check out an AARI process
Check out an Automation Anywhere Robotic Interface (AARI) process from the public workspace to create
an editable copy of the process.
• Ensure you have the Bot Creator license to check out a process to your private workspace.
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• To check out a process with dependent folders and files, you must have the following:
• Create folder permission
• Check-out permission on the dependency folder

1. Log in to the Control Room as a Bot Creator user.
2. In the public workspace, click Bots > My bots.

The My bots page is displayed with the list of folders or files containing the processes.
3. Select the process, open the actions menu (vertical ellipsis), and click Check out process.

The process appears in the same folder structure in the private workspace.

Импорт процесса AARI
Вы можете импортировать процесс Automation Anywhere Robotic Interface (AARI) из одной Control
Room в другую.
• Убедитесь, что для импорта процессов предоставлены указанные ниже права.

• Разрешение на импорт процесса
• Разрешение на создание папки, если требуется
• Разрешение на загрузку
• Разрешение на управление пакетами

• Путь к каталогу процесса необходимо вводить с учетом регистра. Во избежание сбоев при
выполнении процесса убедитесь, что при вводе пути экспорта и импорта в Control Room
используется один и тот же регистр.

В этой задаче нужный процесс уже экспортирован, и по электронной почте получено письмо со
ссылкой на ZIP-файл, содержащий пакет для импорта.
Любой ранее экспортированный процесс находится в общедоступном репозитории и должен быть
импортирован и загружен, чтобы его можно было развернуть из новой Control Room.
The imported process will be available in the public repository.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Щелкните Импортировать бота, затем найдите и выберите процесс для импорта.

Прим.:  Этот параметр в настоящее время применяется к процессам и боты.

3. Выберите параметр импорта процесса в личную или общедоступную рабочую область.
4. Задайте параметр для импорта процесса, руководствуясь тем, находится ли предыдущая версия

процесса в папке назначения.
Во время импорта, если файл уже существует, вы можете либо пропустить процесс, либо
заменить существующий процесс и файл.

5. Щелкните по значку Импорт бота.
6. Щелкните Загрузить.

По завершении импортированный процесс будет помещен в общедоступный репозиторий и
будет готов к развертыванию из новой Control Room.

Импорт зависимостей процесса
При импорте процесса AARI вы можете столкнуться с проблемами, из-за которых импорт может
осуществляться не так, как предполагалось. В этом разделе показаны сценарии успешного импорта.
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Обзор

В этих сценариях Родительский процесс имеет зависимости с Дочерним процессом и Тестовой
формой и требует импорта из Окружения A в Окружение B. Цель заключается в том, чтобы
успешно выполнить импорт из Окружения A в Окружение B.
Параметры
• Родительский процесс использует Дочерний процесс, и вместе они используют Тестовую

форму в Окружении A.
• Экспортируйте Только дочерний ZIP-файл, который содержит Дочерний процесс и Тестовую

форму.

Прим.:  Вы должны экспортировать соответствующие файлы вручную.

• Экспортируйте Только родительский ZIP-файл, который содержит Родительский процесс и
Тестовую форму.

• Экспортируйте Родительско-дочерний ZIP-файл, который содержит Родительский и
Дочерний процессы, а также Тестовую форму.

Сценарий А (лучший вариант)
1. Файлы в Окружении B отсутствуют.
2. Импортируйте Только дочерний ZIP-файл в Окружение B. Файлы Дочернего процесса и

Тестовой формы теперь будут существовать в репозитории.
AARI получает событие массового импорта для файлов Дочернего процесса и Тестовой
формы. Новый процесс под названием Дочерний процесс успешно создается.

3. Импортируйте Только родительский ZIP-файл в Окружение B. Файлы Родительского
процесса и Тестовой формы теперь будут существовать в репозитории.
AARI получает событие массового импорта для файлов Родительского процесса и Тестовой
формы. Поскольку Дочерний процесс существует в AARI, Родительский процесс успешно
создается.

4. Импорт выполняется успешно, поскольку Дочерний процесс и Родительский процесс
созданы в AARI.

В этом сценарии импорт из Окружения A в Окружение B был успешным, поскольку Только
дочерний ZIP-файл импортировался раньше, чем Только родительский ZIP-файл, поэтому
Дочерний процесс и Родительский процесс успешно создавались в AARI.
Это лучший сценарий для успешного импорта.
Сценарий В (условный случай)
1. Файлы в Окружении B отсутствуют.
2. Импортируйте Только родительский ZIP-файл в Окружение B. Файлы Родительского

процесса и Тестовой формы теперь будут существовать в репозитории.
AARI получает событие массового импорта для файлов Родительского процесса и Тестовой
формы. Поскольку Дочерний процесс не существует, это значит, что при создании
Родительского процесса произошел сбой.

© 2023 Automation Anywhere. All rights reserved.     2166



    Automation Anywhere - Сборка

3. Импортируйте Только дочерний ZIP-файл в Окружение B. Файлы Дочернего процесса и
Тестовой формы теперь будут существовать в репозитории.
AARI получает событие массового импорта для файлов Дочернего процесса и Тестовой
формы. Новый процесс под названием Дочерний процесс успешно создается.

4. Повторно импортируйте Только родительский ZIP-файл с помощью параметра Заменить
существующие файлы, выбранного для Окружения B. Файлы Родительского процесса и
Тестовой формы будут заменены в репозитории.
AARI получает событие массового импорта для файлов Родительского процесса и Тестовой
формы. Поскольку Дочерний процесс теперь существует в AARI, Родительский процесс
успешно создается.

Важное замечание:  Если параметр Заменить существующие файлы в не выбран, то
событие массового импорта не генерируется. Поскольку файлы Родительского процесса и
Тестовой формы уже существуют в репозитории, Родительский процесс не может быть
создан в AARI.

5. Импорт выполняется успешно, поскольку Дочерний процесс и Родительский процесс
созданы в AARI.

В этом сценарии при импорте из Окружения A в Окружение B может произойти сбой, если
Только родительский ZIP-файл импортировался раньше, чем Только дочерний ZIP-файл.
Поскольку Родительский процесс может быть создан только в том случае, если необходимые
зависимости из Дочернего процесса существует, если Дочернего процесса не существует в
репозитории, Родительский процесс не может быть создан.
Чтобы обойти эту проблему, пользователь может повторно импортировать Только родительский
ZIP-файл с помощью выбранного параметра Заменить существующие файлы в, чтобы заменить
его в существующем репозитории после того, как будет создан Дочерний процесс, чтобы успешно
создать Родительский процесс. Это действие будет успешным только в том случае, если параметр
Заменить существующие файлы в был выбран пользователем. Если этот параметр не был
выбран, Родительский процесс не может быть создан.
Чтобы избежать этой проблемы, пользователю следует придерживаться сценария А для успешного
выполнения импорта.
Сценарий С (худший случай)
1. Файлы в Окружении B отсутствуют.
2. Import Parent-and-Child zip file into Environment B, files that contains Parent process, Child

process, and Test form will now exist in the repository.
AARI получает событие массового импорта для Родительского процесса, Дочернего процесса
и файлов Тестовой формы. Однако в связи с тем, что отношения между Родительским и
Дочерним процессами не известны из события массового импорта, Родительский процесс
может быть обработан в первую очередь. Поскольку Дочернего процесса не существует, при
создании Родительского процесса происходит сбой.

3. При выполнении импорта происходит сбой, поскольку Дочерний процесс и Родительский
процесс не были созданы в AARI.

В этом сценарии при импорте из Окружения A в Окружение B происходит сбой, поскольку
Родительско-дочерний ZIP-файл был импортирован из-за того, что событие массового импорта
не определяет связь между Родительским и Дочерним процессами. Событие массового импорта
может обработать Родительский процесс перед Дочерним. Это означает, что Родительский
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процесс не может быть создан, поскольку Дочернего процесса не существует, и поэтому новый
процесс не создается в AARI.
Чтобы полностью избежать этой проблемы, пользователю следует придерживаться сценария А для
успешного выполнения импорта.

Export an AARI process
You can export an Automation Anywhere Robotic Interface (AARI) process from one Control Room to
another.
• Only processes within the public workspace can be exported. To export a process, check in the process

into the public workspace.
• Ensure that you have the correct role and permissions to export the process, including the View

package permission.
• To receive the link to the exported package through email, enable SMTP.

Email server settings
• To export the process from one Control Room to another, both Control Rooms must be the same

version.

The Control Room maintains a maximum of 10 GB of historical export files in the download directory. Files
are deleted on a first-in/first-out basis in order to maintain this threshold.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click the Export bot, browse the public directory, and select the process to export.

Прим.:  Этот параметр в настоящее время применяется к процессам и боты.

The selected process as well as the required dependencies are displayed.
3. Щелкните Вперед.

The process and its dependencies are ready for export and displayed in the Review Dependencies
window.

4. Щелкните Вперед.
All related пакеты are displayed.

5. Select the necessary пакеты associated with the process to export.
You can select Exclude process packages to remove all пакеты from the export.

6. Click Export bots and files.
If you have configured SMTP, an email is sent, which contains a link to the zip file of the exported
пакет.
If you have not configured SMTP, perform the following steps to access the link to the zip file of the
exported пакет:
a) Navigate to ACTIVITY > Historical.
b) Search and view the historical activity of the exported package.
c) Click Download exported zip file.

A link to download the zip file is displayed.

7. Use the link to download the zip file and save it to a location for importing it to another Control Room.

Import the process to an Control Room.
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Параметры URL-адреса
Этот раздел поможет вам создать ссылку на параметры URL-адреса для поддерживаемых элементов.

Обзор

You can call a specific AARI process using its ID and pass parameters through the URL to populate the
initial forms based on the form field ID. This method of population is also supported for initial forms in the
iFrame widget for AARI Integrations.

Важное замечание:  Поддерживаемыми элементами, которые могут создавать параметры
URL-адреса, являются Дата, Число, Текстовый бот и Время.

Прим.:  Значение URL-адреса всегда будет заменять значение полей формы по умолчанию.

Формат данных. Некоторые элементы могут принимать определенные форматы данных. К этим
форматам относятся следующие.
• Элементы Текстовое поле, Область текста и Редактор Rich Text принимают тип данных

Строка.
• Элемент Число принимает тип данных Двойное.
• Элементы Дата и Время принимают тип данных RFC 8601 (местное время) (например,

2021-06-10T00:00:00.000)
• Элементы Переключатель и Выпадающее меню принимают тип данных Строка.
• Элемент Флажок принимает тип данных Строка.

Сопоставление параметров. Для определенных элементов отображение различных параметров
выглядит следующим образом.
• Элементы Текстовое поле, Область текста и Редактор Rich Text

• Идентификатор элемента показывает, что значение после идентификатора элемента
становится значением элемента или входным значением.

• Пример.
• TextBox1=MyValue
• TextArea2=MyLoooooooooongValue
• RichTextEditor3=AnUnformattedString

• Элемент Номер
• Идентификатор элемента показывает, что значение после идентификатора элемента станет

значением элемента или входным значением.
• Пример. Number2=123.99

• Элементы Дата и Время
• Идентификатор элемента показывает, что значение после идентификатора элемента станет

значением элемента или входным значением.
• Пример.

• Date1=2021-06-10T00:00:00.000
• Time0=2021-06-10T23:59:17.000
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• Элементы Переключатель и Выпадающее меню
• Идентификатор элемента показывает, что значение после идентификатора элемента станет

значением элемента или входным значением.
• Пример.

• RadioButtonGroup3=TheDefaultOption
• Dropdown0=TheDefaultOption

• Элемент Флажок
• Идентификатор элемента показывает, что значение после идентификатора элемента станет

значением элемента или входным значением.
• Пример. CheckBoxGroup1_1=TheOption2

Разделитель. Вы можете использовать символ & между параметрами

Свойства элемента «Пароль»
Элемент Пароль теперь доступен в веб-интерфейсе. В этом разделе показаны основные функции
этого элемента.

Обзор

Элемент Пароль позволяет добавлять в формы поля паролей, которые можно обрабатывать
в веб-интерфейсе. Этот элемент имеет определенное поведение при использовании в
веб-интерфейсе.
Эти модели поведения выглядят следующим образом.
• Значение поля пароля шифруется, когда пользователь отправляет форму (исходную форму или

часть Задачи, выполняемой человеком).
• Когда другой пользователь получает доступ к этой форме после ее отправки (для просмотра

исходной формы или Задачи, выполняемой человеком в режиме только для чтения), он не
может просмотреть поле пароля, поскольку оно зашифровано.

• Поскольку значения поля пароля зашифрованы, их нельзя использовать в качестве условия
процесса Если/иначе.

• В базе данных хранятся только зашифрованные значения поля пароля. Расшифрованные
значения не сохраняются.

• При передаче зашифрованного значения поля пароля посредством ввода переменной
компонента учетных данных в бот внутри процесса, зашифрованное значение поля пароля
расшифровывается с помощью бот во время развертывания с использованием мгновенного
ключа из хранилища учетных данных. Никакой другой конфигурации не требуется.

Когда вы создаете форму и используете элемент «Пароль», он выглядит как элемент Текстовое
поле за исключением того, что вводимый текст в этих полях теперь маскируются.
Свойства. Элемент «Пароль» будет иметь следующие основные свойства формы
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• Идентификатор элемента
• Это поле может быть отредактировано или перезаписано пользователем, создавшим форму
• Поле принимает уникальное значение по умолчанию (например, значением по умолчанию

может быть password1)

Прим.:  Bot Creator может ссылаться на это поле и предназначен для внутреннего
использования.

• Ярлык элемента
• Это поле может быть отредактировано или перезаписано пользователем, создавшим форму
• Вы можете установить ярлык по умолчанию (например, Пароль)

• Параметры, позволяющие сделать поля пароля обязательными для заполнения или только для
чтения.

Развернуть процессы
AARI on the web interface provides a dedicated workspace to organize processes, create requests, and run
and view tasks. Managers can create new teams and manage their teams' roles and deployment of tasks.
You can access AARI from the Automation 360 home page by clicking the
Explore AARI link which provides a shortcut to the AARI web interface.

The checked-in processes are available on the web interface and can be assigned to the teams so that the
team members can create requests and complete tasks.
The three main components involved in deploying a process are as follows:
• Team management
• Process management

© 2023 Automation Anywhere. All rights reserved.     2171



    Automation Anywhere - Сборка

• Request management

Deployment workflow

The following workflow describes the steps involved in deploying a process by using the web interface:
1. Create an AARI team and assign team roles to members.
2. Assign an AARI team to a process.
3. Создание запроса и завершение задачи.

Другие задачи

Depending on the requirement, you can also perform the following tasks:
• As an AARI manager, you can either assign or unassign tasks to your team members.

Assign or unassign a task.
• To clear the memory space, as an AARI user, manager, or admin, you can delete the requests that are

no longer required.
Delete a request.

• To make process selection easier at the time of request creation, as an AARI user or manager, you can
view, pin, or search for your assigned processes.
View and search for a process.

• As an AARI user, to quickly search for a specific request created, you can filter and search for that
request.
Filter and search for a request.

• As an AARI user, when you have many tasks created from multiple requests, you can filter and search
for a specific task.

Фильтрация и поиск задач.
• You can edit your process in the Process page of the web interface.

Configure an AARI process
• As an AARI admin, you can edit боты to set parameters, enable virtual window, and assign teams to

боты.
Configure an AARI bot

Понятия, связанные с данным
AARI web interface users
Various users are involved in AARI on the web interface and each user contributes in different ways to help
automate the business requirements.
Свойства идентификатора ссылки
Идентификатор ссылки — это ссылка на уникальный ключ, которая позволяет идентифицировать
связанные процессы и запросы. Идентификатор ссылки также отличается для групп, процессов и
ботов.

Team management
Team management is an essential function of AARI in the web interface. The basis of request and process
assignment is dependent on the team setup.
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Обзор

The team configurable in AARI helps business managers to define the following aspects:
• How a request can be created
• How a request is visible to the other users
• Who can read, update, or delete requests

Team structure

A team contains users with specific team roles—admin, owner, and member. The admin has the ability to
modify their team. By default, the AARI manager is the admin of their team. They can create new teams,
manage existing teams, assign team roles (admin, owner, member) to members, and add members to
their team. As an admin, an AARI manager can add other admins to their teams. A team can have more
than one admin but must have at least one admin. To access a process and create new requests, the AARI
manager must request the AARI admin to assign the AARI manager's team to a process.
An AARI admin can also simultaneously add multiple users with similar roles (custom role) to the AARI
team. The custom role in the Control Room is aligned with a team in AARI on the web, and the behavior of
the enhanced team setup is as follows:
• The users added with the custom role are assigned a Member role within the team. This role cannot

be changed to Owner or Admin.
• You cannot view these users added with the custom role in the Users tab of the Manage > Team

page.
• If a user is added through the custom role and also added manually to the team, their role in the team

will be the same as the role assigned to them manually. For example, if the user is a Member, they will
continue to have the Member role whereas if the user is an Owner, they will be assigned the Owner
role in the team.

• If the user is no longer part of a custom role, the user will also not be a part of the team.

For example, create a custom role (aari_role_finance) in the Control Room and add the required users
(aari_user1, aari_user2, aari_mngr1) to this role. You can now add this custom role, aari_role_finance,
to a team in AARI on the web, and the users associated with this role are automatically added to the
team. The team role of the users (aari_user1, aari_user2, aari_mngr1) is Member. The team role of these
users cannot be changed from Member to either Admin or Owner. If aari_user2 is added as a part of
aari_role_finance and also added manually through the Users tab and the role is Owner, then the team
role of this user is retained as Owner.

Team types

Each team is configured to a team type (shared or private) and depending on that type, requests that can
be viewed and accessed by members of that team might change.
• Shared: All the requests can be viewed by admins, owners, and members of that team.
• Private: Requests can be viewed only by the users creating those requests and the owner and admin

of the team.

The team roles are based on the Control Room role assigned to the user. Each team role has a subset of
permissions and actions that can be performed by that role. These sets of permissions vary between the
shared and private team types.
Понятия, связанные с данным
AARI web interface users
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Various users are involved in AARI on the web interface and each user contributes in different ways to help
automate the business requirements.

Process management
A process contains human tasks and бот tasks. The AARI teams can use the process to automate their
tasks by creating requests.
The AARI admin performs the global process management tasks. The AARI admin can view the checked-in
processes from the Control Room and assign teams to a process for request creation.
You can view your requests on the Processes page. For easy access to a specific process, you can
sort the processes by name in ascending or descending order and toggle the pinning of a process. The
responsive view of the Processes page adjusts the display to your screen size. To guide with your team
assignment, you can also reference the team from which a request is created by referring to the team
name added in the process tile on the Processes page.

Request management
A request must be created to automate processes to complete assigned tasks. Members of a team create
requests and complete the corresponding tasks.
Requests must always be created within a team. This ensures that the teams assigned to the same process
cannot see each other's data anymore. By default, an AARI user, selected as an owner or member of their
team, can create requests because their role has the AARI user license, which enables them to access the
web interface and create requests.
The structure of request creation is as follows:
• An AARI user (team owner or member) can access and view all the processes that are assigned to a

team on the Processes page.
• The AARI user must provide all the required information in an initial form.
• The боты and human tasks run in the request view page, which contains high-level details of the

tasks.
• The task information is displayed in the Requests page, for the AARI user to verify.
• The AARI user can view their requests on the Requests page. They can manage or sort their existing

requests by using a filter.
• A request can be created by either a user or a бот on the Edit Process page. If the request is created

by a user, the process is displayed on the Processes page. If the request is created through a бот, the
user cannot create a request or view the process.

Свойства идентификатора ссылки
Идентификатор ссылки — это ссылка на уникальный ключ, которая позволяет идентифицировать
связанные процессы и запросы. Идентификатор ссылки также отличается для групп, процессов и
ботов.

Обзор

Основная цель идентификатора ссылки — помочь пользователю быстро определить все связанные
процессы и количество запросов, созданных в рамках того или иного процесса.
Запросы
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Идентификатор ссылки создается на основе Ключа процесса — уникального текста, который
пользователь может ввести при редактировании своего процесса. Когда пользователь настраивает
ключ процесса, он создает префикс, соответствующий его процессу.
Улучшения ключей.
• В столбце Ссылка на странице Запросы показаны номера идентификаторов ссылок (например.

2-42, 98-10, MAIN-5).
• Ключ процесса и число итераций запросов позволяют пользователю определить

последовательную согласованность между числом запросов для данного процесса (например,
процесс Финансы с ключом процесса FIN и числом новых запросов отображается как FIN-1,
FIN-2, FIN-3, FIN-10).

Улучшения URL-адреса.
• URL-адрес на странице Запросы теперь изменен на entity/ref/:ref (вместо entity/:id).
• Пользователь может получить доступ к своим запросам путем ввода Идентификатора ссылки

(например, /aari/#/requests/all#/requests/ref/2-34)
• Если пользователь открывает любой запрос, используя ID запроса, URL-адрес теперь

перенаправляется с использованием Ссылки. Например, рассмотрим ID запроса 896 и Ссылку
2-34 для запроса. Если пользователь просматривает запрос, используя ID запроса (/aari/#/
requests/all#/reqeusts/896), URL-адрес будет перенаправлен с использованием Ссылки (
/aari/#/requests/all#/reqeusts/2-34).

Сценарий. Создание ключа процесса для просмотра идентификатора ссылки
1. Вы редактируете процесс Бета, чтобы создать Ключ процесса под названием ALPHA.
2. Вы создаете несколько запросов из процесса Бета.
3. Для каждого запроса, созданного из процесса Бета, итерация ключа процесса ALPHA будет

выполнена однократно.
4. Вы получаете доступ к странице Запросы и просматриваете столбец Ссылка.
5. В столбце Ссылка отображены ALPHA-1, ALPHA-2, ALPHA-3. Это идентификаторы

ссылки.
6. Теперь вы можете просмотреть идентификатор ссылки для всех связанных процессов.

Бот/процесс/группа
Функция для Бота, Процесса и Группы отличается от функции для Запроса. ID запроса
из предыдущего окружения теперь заменяется на идентификатор ссылки. Это сделано для
улучшения работы с одним клиентом путем создания логической последовательности к ссылочному
номеру.
Улучшения URL-адреса.
• На странице Редактировать процесс теперь отображается обновленный URL-адрес (например,

/aari/#/manage/process/ref/96), благодаря чему пользователь может получить прямой
доступ к процессу при вводе идентификатора ссылки.

• На странице Редактировать группу теперь отображается обновленный URL-адрес (например, /
aari/#/manage/ team/ref/123), благодаря чему пользователь может получить прямой доступ
к группе при вводе идентификатора ссылки.
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Изменения в обновлении AARI с версии A360.21 или более поздней
С версии A360.21 или более поздней в веб-интерфейсе AARI изменился порядок работы групп.
Расширенное управление группой теперь помогает бизнес-менеджерам определить, как можно
создать запрос. Они также могут указать, кто может просматривать или удалять запросы.
Чтобы гарантировать непрерывность в существующем поведении для пользователей, которые
осуществляли какой-либо доступ к процессу или создавали запросы из процесса (независимо от
существующего назначения группы), необходимо соблюдать указанные ниже условия.
• Доступ пользователя к созданию запроса на определенный процесс сохраняется.
• Также сохраняется доступ пользователя к просмотру запросов из процесса, независимо от того, в

какой группе он состоял.

Как изменяются существующие группы

Чтобы сохранить текущий доступ к процессам и существующим группам, существующие группы
остаются следующими:
• Существующий процесс, назначенный им.
• Те же участники, назначенные группе.
• Тип группы настроен на общий доступ. Это гарантирует, что все участники группы смогут

просматривать перенесенные процессы и запросы.
• Участники группы выполняют одну из следующих функций группы:

• Менеджер AARI или администратор AARI — функция администратора
• Пользователь AARI — функция участника

Чтобы сохранить текущий доступ к запросам, для каждого процесса создаются новые группы, и
новая группа имеет следующие особенности:
• Существующие процессы, назначенные группе, называются «Группы, перенесенные для процесса

X», где X — идентификатор процесса. Это помогает ссылаться на перенесенные процессы.
Группы создаются для существующих процессов с таким именем.

• Пользователи, которые ранее имели доступ к процессу, назначаются этой группе независимо от
их существующего назначения группе, а группа назначается процессу.

• Тип группы настроен на общий доступ.
• Участники группы выполняют одну из следующих функций группы:

• Менеджер AARI администратор AARI
• Пользователь AARI

Ранее менеджеры AARI могли создавать запросы, не назначая процессы группам. После обновления
они должны создать группы и попросить администратора AARI назначить свою группу процессу,
чтобы создавать новые запросы.

Важное замечание:  После выполнения процесса миграции и создания перенесенной группы при
создании запроса будут выбраны два процесса (по одному для каждой группы). Эти два процесса
будут иметь разные типы поведение для видимости запроса.
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Пример

Следующий сценарий поможет проиллюстрировать работу обновления.
Рассмотрим процесс под названием «Закрытие кредита» с идентификатором процесса 47. Джордж —
пользователь с функцией администратора AARI в Control Room.
Перед обновлением
Две группы HR и IT имеют доступ к процессу закрытия кредита, и структура групп выглядит так, как
указано в таблице ниже.

HR IT

Имя пользователя Функция в Control
Room

Имя пользователя Функция в Control
Room

Боб Менеджер AARI Грейс Менеджер AARI

Кэрол Пользователь AARI Стив Пользователь AARI

Дебби Пользователь AARI Дебби Пользователь AARI

Поведение до обновления выглядит следующим образом:
• Пользователи из группы HR могут просматривать запросы, созданные в группе IT, и наоборот.
• Боб и Грейс могут назначать процессы, которые ранее были назначены им Джорджем,

соответственно группе HR и IT.
• Боб может управлять группой HR, и точно так же Грейс может управлять группой IT, например

добавлять участников, назначать процессы, переименовывать группу и так далее.

После обновления
Две исходные группы (HR и IT) остаются, и во время обновления дополнительно создается одна
новая группа (с названием «Группа, перенесенная для процесса 47»). Структура всех трех групп
приведена в таблице ниже:

HR IT Группа, перенесенная для
процесса 47

Имя
пользователя

Функция
группы

Функция
в Control
Room

Имя
пользователя

Функция
группы

Функция
в Control
Room

Имя
пользователя

Функция
группы

Функция
в Control
Room

Боб АдминистраторМенеджер
AARI

Грейс АдминистраторМенеджер
AARI

Боб АдминистраторМенеджер
AARI

Кэрол Участник Пользователь
AARI

Стив Участник Пользователь
AARI

Кэрол Участник Пользователь
AARI

Дебби Участник Пользователь
AARI

Дебби Участник Пользователь
AARI

Дебби Участник Пользователь
AARI

Пользователь
AARI

Грейс АдминистраторМенеджер
AARI

Стив Участник Пользователь
AARI

Поведение групп после обновления выглядит следующим образом:
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• Участники группы HR больше не могут просматривать запросы, созданные в группе IT, и
наоборот.

• Поскольку Дебби является участником групп HR и IT, этот пользователь может создавать запросы
в обеих группах. Во время создания запроса для пользователя отображаются две различные
карты процессов.

• Старые запросы, созданные в группах HR и IT, обрабатываются так, как если бы они были
созданы в общей группе под названием «Группа, перенесенная для процесса 47», которой
назначен только процесс закрытия кредита (47).

• Участники групп HR и IT входят в состав «Группы, перенесенной для процесса 47», поэтому
они могут получать доступ к старым запросам. При удалении «Группы, перенесенной для
процесса 47» удаляются связанные с ней запросы, поэтому доступ к старым запросам удаляется и
не может быть восстановлен.

• Участники группы HR или IT могут создавать запросы внутри «Группы, перенесенной для
процесса 47», и эти запросы видны всем участникам групп HR и IT.

• Боб и Грейс могут управлять группой HR и IT соответственно, а также совместно управлять
«Группой, перенесенной для процесса 47». Это означает, что они могут добавлять участников в
группу, переименовывать группу, удалять участников из группы и т. д.

• Теперь Боб и Грейс могут просматривать только процессы, назначенные Джорджем их группам.

Important:  Во время обновления могут периодически возникать проблемы с назначением
администраторов групп, когда либо создателю группы неправильно назначается функция
участника группы вместо функции администратора группы, либо другим участникам группы
назначается функция администратора группы вместо функции участника группы. После обновления
администратор AARI должен всегда проверять назначение администратора группы.
В следующем примере объясняется проблема назначения администратора группы:
Перед обновлением Боб создает группу HR и выполняет функцию менеджера AARI, а Кэрол,
Дебби, Грейс и Стив являются участниками группы и имеют функции пользователей AARI.
После обновления Бобу назначается функция администратора группы вместе с Кэрол. Дебби,
Грейс и Стив получают функции участников группы. В этом случае Кэрол неправильно назначена
функция администратора вместо функции участника. Администратор AARI должен проверить
назначение администратора группы и изменить функция Кэрол на участника группы.

Создание запроса и завершение задачи
Пользователь AARI может создать новый запрос из процессов, которым назначена его группа,
ввести необходимую информацию в исходную форму и выполнить задачи.
Убедитесь, что вы выполнили указанные ниже действия.
• Предоставили созданную системой функцию AAE_Robotic_Interface User пользователю AARI.
• Назначили пользовательскую лицензию AARI.
• Получили доступ к веб-интерфейсу.

1. Войдите в веб-интерфейс в качестве пользователя AARI.
Будучи пользователем AARI, теперь вы назначены в группу с функцией владельца или
участника группы, созданную менеджером или администратором AARI.

2. Перейдите на страницу Процессы.
На этой странице отображаются все доступные процессы, которым ваша группа была назначена
администратором AARI.
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3. Выберите назначенный процесс.
Появится исходная форма, в которой будут отображены необходимые поля для заполнения. Эти
поля относятся к поддерживаемым интерактивным элементам формы.

Важное замечание:  Процессы теперь включают в себя названия групп, связанных с
процессом, которому назначена группа. Название группы Группа, перенесенная для
процесса указывает на то, что процесс доступен участникам группы, которые ранее имели
доступ к этому процессу, независимо от назначения группы, до момента обновления Automation
360.

4. Введите необходимую информацию в исходную форму.
Вы также можете заполнить исходные формы с использованием параметров URL-адреса, к
которым относятся элементы Дата, Число, Текстовое поле и Время.

5. Необязательно: Чтобы просмотреть запрос в другой вкладке, выберите параметр Открыть
запрос в новой вкладке.

6. Щелкните Отправить, чтобы подтвердить информацию и продолжить.
По желанию вы можете щелкнуть Отменить, чтобы отменить изменения.

7. Просмотрите страницу просмотра запроса.
Теперь ваш процесс запущен, и вам может быть предложено завершить ожидающие задачи на
вкладках запросов.

8. Введите необходимую информацию о задаче на вкладке запроса.
По завершении своей задачи бот может предложить вам взять на себя выполнение оставшихся
шагов.

9. Просмотрите состояние своего запроса.
Ваш запрос выполнен.

10. Перейдите в раздел Запросы > Все запросы, чтобы просмотреть все запросы, созданные в
группе.

11. Необязательно: Щелкните Создать запрос, чтобы создать новый запрос на странице Запрос.

Delete a request
An AARI user, manager, or administrator can delete requests that are no longer required. Deleting requests
helps clear the memory space. You can also recover a deleted request if necessary.
Убедитесь, что вы выполнили указанные ниже действия.
• Assigned a system-created AAE_Robotic_Interface User role for the AARI user,

AAE_Robotic_Interface Manager for the AARI manager, or AAE_Robotic_Interface Admin role
for the AARI administrator.

• For the AARI user, manager, or admin:
• Назначили пользовательскую лицензию AARI.
• Provided access to AARI on the web.

Only requests that are in Aborted, Cancelled, Failed, or Completed status can be deleted.
• An AARI administrator can delete any request.

Прим.:  The AARI administrator is the only user who can permanently delete requests.

• The AARI manager can delete requests of the team for which they are the owner.

© 2023 Automation Anywhere. All rights reserved.     2179



    Automation Anywhere - Сборка

• The AARI user can delete only the requests they have created.

Важное замечание:  Files that are associated with a process is deleted when the request are
deleted or are automatically deleted after 90 days.

1. Войдите в веб-интерфейс.
2. Navigate to the Request tab.
3. From the list of requests, select the request or requests you want to delete and click the delete icon.

A confirmation message appears to confirm the deletion.
4. Click Yes, delete to delete the selected requests.
5. Необязательно: To recover a deleted request or requests, perform these steps:

a) Navigate to the Recycle Bin tab.
b) Select the requests you want to recover and click the recover icon.

A confirmation message appears to confirm recovery of the request.
c) Click Yes, recover.

The requests are recovered and appear in the Requests tab.

Create an AARI team and assign team roles to members
An AARI manager is a team admin who can create new teams, add members to their team, and assign
new team roles. AARI admin can also configure a team but does not have a team role.
Убедитесь, что вы выполнили указанные ниже действия.
• Provided a system-created AAE_Robotic_Interface Manager role for the AARI manager.

Прим.:  In addition, the AARI manager requires the AARI license.

• Provided a system-created AAE_Robotic_Interface Admin role for the AARI admin.
• Получили доступ к веб-интерфейсу.

1. Log in to the web interface as an AARI manager or admin.
2. Navigate to Manage > Team.

The Team page enables the AARI manager or admin to view all of their teams and provides the
option to create a new team.

3. Click Create new team.
A Create new team window prompts for the AARI manager or admin to enter the team details.

4. Enter a team name in the Team Name field.
5. Необязательно: Enter a description in the Description field.
6. Select a user from the drop-down in the Team admin field.
7. In the Request Visibility field in the General tab, select Shared or Private.

If you select the Shared option, then all the requests that are created are accessible to members of
the team. If you select the Private option, then a request will be available only to the member who
created that request and the owners and admins of the team.
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8. Add members to the team by choosing one of the following options:
Вариант Шаги

Пользователи a. Click the + (plus) icon. The Add members window appears. Use it to
search for members to add.

b. Search by using name, email, username, or role in the search bar.
c. Select the member from the displayed list.
d. Click Add & save. Members are now successfully added to the team.
e. Optional:  To remove a team member, select the member and click

the trash icon.

f. Navigate to Roles next to each member name. Each member's team
role is set to Member, by default.

g. Click Member to change the team role when applicable.
h. Select Member, Owner, or Admin to designate the team role.

Important:  A team must have at least one Admin as a member.
Only the AARI manager can be assigned the Admin team role because
the roles are based on theControl Room roles assigned to the user. A
team, however, can have more than one admin.

Функции a. Click the + (plus) icon. The Add roles window appears. Use it to
search for roles to add.

b. Search for a role in the search bar.
c. Select the role from the displayed list.
d. Click Add & save. Roles are now successfully added to the team.
e. Optional:  To remove a role, select the role and click the trash icon.

9. Необязательно: Click the Processes or Bots tabs respectively to view the assigned processes or
боты.

10. Щелкните Закрыть.
11. Необязательно: To edit an existing team, click the team's name in Team column within Team Setup

page.
The AARI manager or admin can edit a team to update their team setup or click Delete to erase the
team entirely.

Assign an AARI team to a process
An AARI admin can configure processes in the web interface and assign teams to a process for request
creation. They access the web interface to view and manage processes in the Process Setup page.
Убедитесь, что вы выполнили указанные ниже действия.
• Provided a system-created AAE_Robotic_Interface Admin role for the AARI admin.
• Получили доступ к веб-интерфейсу.

© 2023 Automation Anywhere. All rights reserved.     2181



    Automation Anywhere - Сборка

As an AARI admin, their key function is to assign teams to a process.
1. Log in to the web interface as an AARI admin.
2. Navigate to Mangage > Process setup

The Process Setup page enables the AARI admin to view all of the check-in processes from the
Control Room and assign teams to a process.

3. Click on a process.
An Edit Process window appears and shows related information about the process such as the
process name, description, tags, and teams.

4. Edit the Process name field if necessary.
5. Необязательно: Enter a description in the Description field.
6. Click Add tag in the Tags field to add tags to the process.

The Add tag window appears to search for tags to add.
7. Search for a tag description in the search bar.
8. Click on their name to confirm the tag.
9. Click Add.
10. Выберите пользователя планировщика из выпадающего меню в поле Планировщик.

Прим.:  The Global scheduler option is selected by default if a scheduler is not set for any process.

11. Select the by user (default) or by bot options in the Request creation field.

Важное замечание:  If the by user option is selected, then processes are visible in the Processes
page for all AARI users (owners or members of team). If the by bot option is selected, then the
request is created by a bot or another process using the Process Task in the Process Composer. A
team must be selected in the Default team to take the bot created request field, for requests to
be created by that team.

12. Click the + (plus) icon to add teams to the process.
The Add teams window appears to search for teams to add.

13. Search for a team in the search bar.
14. Click on their name to confirm the team.
15. Click Add.

Team are now successfully added to the process.
16. Необязательно: To remove a team, click the trash icon next to the team name.
17. Щелкните Сохранить.

Assign or unassign a task
The Automation Anywhere Robotic Interface (AARI) manager and user can assign specific tasks to their
team. They can also unassign tasks.
Убедитесь, что вы выполнили указанные ниже действия.
• Provided a system-created AAE_Robotic_Interface Manager role for the AARI manager.
• Предоставили созданную системой функцию AAE_Robotic_Interface User пользователю AARI.
• Получили доступ к AARI в Интернете.

Managers can assign tasks to all members who have access to a process. Users can assign tasks to other
users in the same team. Managers and users can unassign tasks.
1. Log in to the web interface as an AARI manager.
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2. Navigate to the Tasks tab.
3. Select a task from the list.
4. Перейти в

• Unassigned
Tasks are unassigned by default.

• Assign to me
This option assigns the task to the current user.

5. Select the user.
The task is now assigned.

6. Необязательно: Select Unassigned.
The task is now unassigned.

View and search for a process
The AARI user can view, pin, or search their assigned processes.
Убедитесь, что вы выполнили указанные ниже действия.
• Предоставили созданную системой функцию AAE_Robotic_Interface User пользователю AARI.
• Назначили пользовательскую лицензию AARI.
• Получили доступ к AARI в Интернете.

1. Войдите в веб-интерфейс в качестве пользователя AARI.
2. Click Create request from the home page and choose from these options:

Вариант Шаги

View a process View your assigned process in the Select a process window.

Важное замечание:  A list of processes is available in
the All tab by default and are assigned to your team by the
manager.

View a pinned process a. Click the pin icon.
b. Navigate to the Pinned tab.
c. View your pinned process.

Search for a process a. Click Create request from the home page.
b. Navigate to the search bar.
c. Enter your keyword.

The search bar dynamically searches your processes for
common keywords. You can also search for tags.

d. View the searched process.
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Filter and search for a request
When an AARI user has created many requests, they can quickly search for a specific request in the
Requests page.
Убедитесь, что вы выполнили указанные ниже действия.
• Предоставили созданную системой функцию AAE_Robotic_Interface User пользователю AARI.
• Назначили пользовательскую лицензию AARI.
• Получили доступ к AARI в Интернете.

Follow these steps to quickly search or filter your requests:
1. Войдите в веб-интерфейс в качестве пользователя AARI.

You are now in your home page, where you can view your requests.
2. Navigate to the Requests page and choose from these options:

Вариант Шаги

Сортировать a. Щелкните по столбцу.
Вы можете выбирать нужные параметры из
указанных ниже доступных вариантов. Status,
Reference, Process,Team, Request title
Created , Updated or Tags.
По умолчанию элементы столбца отображаются в
порядке возрастания.

b. Необязательно. Снова щелкните по этому же
столбцу.
The column is now sorted to descending order.

c. View your sorted requests.
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Вариант Шаги

Искать a. Щелкните Статус (установлено по умолчанию).
You can search by Request title, Reference,
Process, Tags, Data Privacy Tags (AARI Admin
only), and Team.

b. Search for your request.
Строка поиска позволяет выполнять динамический
поиск распространенных ключевых слов.
• Введите заголовок в поле Заголовок

запроса.
• Введите ключ ссылки в поле Ссылка.
• Enter a process name in the Process field.
• Enter a tag name in the Tags field.
• Enter a team name in the Team field.
• Необязательно. Введите запрос в поле Тег

конфиденциальности данных.

Прим.:  Этот параметр доступен только
для администратора AARI. Администратор
может обновлять поле и управлять любой
информацией о конфиденциальности данных.

c. Необязательно. Щелкните x, чтобы убрать
ключевые слова из поиска.

d. View the searched requests.

Фильтр a. Щелкните Статус (установлено по умолчанию).
You can filter by selecting from the drop-down menu.

b. Выберите нужный вариант из выпадающего меню.
You can choose from Completed, Failed,
Cancelled, and Open.

c. Необязательно. Click x to clear filtered keywords.
d. View your filtered requests.

Date a. Выберите поле Дата создания или Дата
обновления.
Появится окно диапазона дат.

b. Выберите текущую дату или укажите любые даты
в полях C и До.

c. Щелкните Отправить.
d. View your requests by the creation or modified dates.
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Фильтрация и поиск задач
Если пользователь AARI создал несколько задач, он может быстро найти определенную задачу на
странице Задачи.
Убедитесь, что вы выполнили указанные ниже действия.
• Предоставили созданную системой функцию AAE_Robotic_Interface User пользователю AARI.
• Назначили пользовательскую лицензию AARI.
• Получили доступ к AARI в Интернете.

Выполните указанные ниже действия для быстрого поиска или фильтрации задач.
1. Войдите в веб-интерфейс в качестве пользователя AARI.

Теперь вы находитесь на главной странице, где вы можете просматривать свои задачи.
2. Navigate to the Tasks page and choose from these options:

Вариант Шаги

Сортировать a. Щелкните по столбцу.
Вы можете выбирать нужные параметры из
указанных ниже доступных вариантов. Status,
Task Name, Assignee,Team, Request title,
Reference, Task Created, Task Updated.
По умолчанию элементы столбца отображаются в
порядке возрастания.

b. Необязательно. Снова щелкните по этому же
столбцу.
Теперь элементы столбца отображаются в
порядке убывания.

c. Просмотрите отсортированные задачи.
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Вариант Шаги

Искать a. Щелкните Статус (установлено по умолчанию).
You can search by Task Name, Request title,
Reference, Data Privacy Tags (AARI Admin only),
Assignee, and Team.

b. Найдите свою задачу.
Строка поиска позволяет выполнять
динамический поиск распространенных ключевых
слов.
• Введите название задачи в поле Название

задачи.
• Введите заголовок в поле Заголовок

запроса.
• Введите ключ ссылки в поле Ссылка.
• Введите имя назначенного лица в поле

Правопреемник.
• Введите название группы в поле Группа.
• Необязательно. Введите запрос в поле Тег

конфиденциальности данных.

Прим.:  Этот параметр доступен только
для администратора AARI. Администратор
может обновлять поле и управлять любой
информацией о конфиденциальности данных.

c. Необязательно. Щелкните x, чтобы убрать
ключевые слова из поиска.

d. Просмотрите найденные задачи.

Date a. Выберите поле Дата создания или Дата
обновления.
Появится окно диапазона дат.

b. Выберите текущую дату или укажите любые даты
в полях C и До.

c. Щелкните Отправить.
d. Просматривайте задачи по датам создания или

изменения.

Предустановленные фильтры в
табличном представлении

a. Перейдите на вкладку Табличное
представление (установлена по умолчанию).

b. Щелкните Мои завершенные задачи,
Мои задачи в режиме ожидания или
Неназначенные задачи.

c. Просмотрите отфильтрованные задачи.
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Вариант Шаги

Фильтрация в табличном
представлении

a. Щелкните Статус (установлено по умолчанию)
или Тип.

b. Выберите нужный вариант из выпадающего меню.
Для параметра Статус можно выбрать значение В
ожидании, Отменено и Завершено.
Для параметра Тип вы можете выбрать значение
Форма и Валидация.

c. Просмотрите отфильтрованные задачи.
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Вариант Шаги

Фильтрация в подробном
представлении

a. Перейдите на вкладку Подробное
представление.

b. Щелкните Фильтр.
c. В появившемся специальном окне фильтра

настройте содержимое для параметров
фильтрации.
• Выберите фильтр из предустановленных

вариантов: Мои завершенные задачи,
Мои задачи в режиме ожидания и
Неназначенные задачи.

• Выберите дату в поле Дата создания или
Дата обновления.
Вы можете выбрать текущую дату или указать
любые даты в полях C и До.

• Выберите значение для параметра Статус.
Вы можете выбрать значение Ожидание,
Отменено и Завершено.

• Введите название задачи в поле Название
задачи.

• Введите имя в поле Заголовок запроса.
• Enter a name in the Created by field.
• Введите ключ ссылки в поле Ссылка.
• Выберите значение для параметра Тип.

Вы можете выбрать варианты Форма и
Валидация.

• Введите имя в поле Правопреемник.
• Необязательно. Введите запрос в поле Тег

конфиденциальности данных.

Прим.:  Этот параметр доступен только
для администратора AARI. Администратор
может обновлять поле и управлять любой
информацией о конфиденциальности данных.

d. В списке задач фильтрацию можно выполнять
с помощью дополнительных параметров
сортировки.
1. Щелкните Задача создана (установлено по

умолчанию).
2. Select in the Sort By field from Status, Task

Name, Reference, Title, and Task Created
options.

3. В поле Порядок выберите параметр По
возрастанию (установлено по умолчанию)
или По убыванию.

e. Необязательно. Щелкните x, чтобы удалить
ключевые слова или теги, выбранные в целях
фильтрации.

f. Просмотрите отфильтрованные задачи.
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Configure an AARI bot
В этой задаче показано, как редактировать бота для установки параметров, а также для управления
участниками группы.
1. Войдите в веб-интерфейс.
2. Перейдите в раздел Управление > Бот.
3. Щелкните по доступному боту.

Откроется страница Редактировать бота на вкладке Общие.
4. Укажите имя в поле Отображаемое имя бота.
5. Используйте имя файла для ссылки в поле Имя файла бота

Прим.:  Поле выделено серым цветом и не может быть изменено, так как оно служит для
ссылки на имя этого файла бот.

6. Используйте URI-адрес для ссылки в поле Uri

Прим.:  Поле выделено серым цветом и не может быть изменено, так как оно служит для
ссылки на URI-адрес этого бот.

7. Необязательно: Введите описание для вашего бота.
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8. Необязательно: Select the Run this bot in virtual window check box.

This option enables the Picture-in-Picture (PIP) feature in Microsoft Windows. This feature enables
attended users to run боты in AARI Assistant on a virtual desktop window, while they continue to
work on other applications. For more information on AARI Assistant, see Сведения о AARI Assistant.
Attended users can also use the PIP feature to run attended боты from the iFrame widget in their web
applications, see Embedded Automation.

Важное замечание:  Microsoft Windows 8, Microsoft Windows Server 12, or any of the later
versions are required for virtual window. Here are some of the existing limitations of using the PIP
feature:
• Another instance of your current browser cannot be used on Windows Desktop and the virtual

window at the same time.
For example, if you are using an instance of Google Chrome on your Windows Desktop, the same
cannot be used in the virtual window. In order to use Google Chrome in the virtual window, ensure
you close this browser on your Desktop.

• When a virtual window is initiated, you might be logged out of your connected Global Protect
software. However, the TaskBot will continue to run in the virtual window.

• Applications that allow single log in are restricted to the corresponding main or virtual windows.
• After a бот starts, it runs in the virtual window and is completely independent of the main instance.

9. Необязательно: Выберите Удалить бота чтобы удалить этого бот.

Важное замечание:  При использовании этого параметра бот будет удален без возможности
восстановления.

10. Щелкните вкладку Группы.
На этой странице вы можете управлять участниками вашей группы.

11. Щелкните кнопку Добавить (+).
Появится страница Добавить группы.

12. Выберите доступную группу.
13. Щелкните Добавить и сохранить, чтобы подтвердить выбор.

В настоящее время для этого бот назначена группа.
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14. Необязательно: Выберите группу и щелкните кнопку Удалить (переместить в корзину), чтобы
удалить группу.

15. Необязательно: Выберите строку поиска и выполните фильтрацию по следующим параметрам:
Группа, Описание и Запросить видимость (Личные или Общие).

16. Щелкните Закрыть.
Ваши настройки сохранятся автоматически.

Configure an AARI process
В этом задании показано, как отредактировать процесс, чтобы создать ключ процесса, установить
группу по умолчанию, а также включить параметр для удаления процесса.

1. Войдите в веб-интерфейс.
2. Перейдите в раздел Управление > Процесс.
3. Щелкните по доступному процессу.

Откроется окно Редактировать процесс на вкладке Общие.
4. Укажите имя в поле Имя процесса.
5. Необязательно. Укажите описание в поле Описание.
6. Введите ключ клиента (если применимо) в поле Ключ процесса.

Важное замечание:  Ключ процесса должен содержать от одного до пяти символов,
расположенных в алфавитном порядке. Ключ процесса может быть определен только один раз,
и после этого он не может быть изменен пользователем.

7. Добавьте теги к вашему процессу в поле Теги.
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8. In the Tags field:
a) Click the Tags field.
b) Specify your tags with unique keywords, such as Cases or Reports.
c) Select the Add as new option from the drop-down to add a new tag.

The keyword will automatically generate a new tag if it does not exist. The search result is
displayed in real time.

d) (Optional) Select an existing tag from the drop-down.

© 2023 Automation Anywhere. All rights reserved.     2193



    Automation Anywhere - Сборка

e) (Optional) Select the trash bin icon to delete your tags in the field.

Прим.:  Only the AARI admin can view and create tags.

9. Укажите группу в поле Группа по умолчанию.
По умолчанию первая группа, добавленная в процесс, автоматически устанавливается в
качестве группы по умолчанию. Вы можете изменить группу, выбрав ее из выпадающего меню.

Важное замечание:  Группу по умолчанию нельзя удалить из процесса. Чтобы администратор
мог удалить группу по умолчанию (например, группу 1), ему потребуется установить другую
группу (например, группу 2) в качестве группы по умолчанию, а затем удалить исходную группу
(например, группу 1) из процесса.

Пример. Вы можете выбрать параметр Директор по подбору персонала в выпадающем
меню.

10. Выберите параметр по пользователю или по боту в поле Создание запроса.
11. В поле Хранение запросов выполните следующие действия.

• Выберите Отключено, Немедленно или Пользовательский из первого выпадающего
меню, чтобы указать, будет ли завершенный запрос перемещен из списка Запрос в
Корзину.
For example, you can select Disabled to prevent your requests from being moved to the Recycle
bin or select Immediate for all current completed requests to be moved without delay.

Прим.:  When you select the Immediate option, it can take a maximum time of one hour before
the request is moved to the Recycle bin.

• Выберите Немедленно или Пользовательский во втором выпадающем меню, чтобы
указать количество дней, в течение которых запросы будут удалены из Корзины без
возможности восстановления.
Пример. Вы можете выбрать Пользовательский и указать 30, чтобы запрос был удален из
Корзины через тридцать дней.

• Установите флажок, чтобы разрешить перемещение открытых запросов в Корзину.

12. Щелкните Закрыть.
Ваши настройки сохранятся автоматически.

Бот setup
The AARI admin can manage and assign боты to a team of attended Bot Runner users, for them to view
боты in the AARI Assistant.
The main purpose of this feature is to improve the bot assignment for attended Bot Runner users, to
enable them to access only the боты that are assigned to their team by an AARI admin.
This helps control which users can view or use a бот. However, if an attended Bot Runner user is not apart
of any team, they will be able to view and access all bots in the AARI Assistant.
For the AARI admin to assign a team of attended Bot Runner users to a бот, they must have view
permissions on folders containing the бот.
• The AARI admin can access the Bot Setup page in the web interface to view all боты and assign them

to a team. They can also assign multiple teams to a бот or remove teams from боты entirely.
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• When new боты are added to this page, the боты can be assigned to a team of attended Bot Runner
users.

• The attended Bot Runner users can view their assigned боты in the AARI Assistant.
• The attended Bot Runner user must have a role with access to the public folder where the bot resides.

Attended and unattended automation
The Automation Anywhere RPA Workspace provides attended and unattended automation for users to
create боты that can manage routine tasks efficiently. While users focus on critical inputs that require
manual overview or approval, боты handle tasks such as gathering information across databases,
validating data, or responding to chats.

Обзор
Collaboration between humans and software боты is called attended automation. As attended automation
requires user supervision, it is best suited for use with smaller and more fragmented tasks. However,
some tasks within a business process do not change a lot over time and might not require extensive
user intervention, such as collecting data or retrieving information from multiple databases. When such
tasks that require little or no user judgment are configured to trigger other боты, it is called unattended
automation. Unattended automation is useful to perform privileged operations, requiring elevated
permissions and credentials.
Automation 360 offers a combination of attended and unattended automation for a complete RPA solution
with the following benefits:
• Automated integration between multiple applications or databases, reducing errors as very little user

intervention is necessary.
• Access боты in real-time through an easy to use interface.
• Users can set up or change triggers to start боты based on real-time.

Watch the following video to understand attended automation:
Понятия, связанные с данным
Using AARI on desktop
Use Automation Anywhere Robotic Interface (AARI) through your desktop to manage routine tasks such as
validating data, retrieving approvals, and managing escalations through боты.
Информация, связанная с данной
Using bots to solve problems

Using AARI on desktop
Use Automation Anywhere Robotic Interface (AARI) through your desktop to manage routine tasks such as
validating data, retrieving approvals, and managing escalations through боты.
The following workflow describes how to use AARI to automate and manage your tasks:
1. Create a user:

• The Control Room administrator creates a user with a Bot Creator license.
Create a user | Лицензии Automation 360

• The user logs in to the Control Room to start building боты.

Установка Bot Agent и регистрация устройств | Get started building боты

© 2023 Automation Anywhere. All rights reserved.     2195

https://developer.automationanywhere.com/learn/bot-developer-journey/using-bots-to-solve-problems


    Automation Anywhere - Сборка

2. Create forms using the Interactive forms package:
• Interactive forms enable you to design forms for submitting and regrouping data from various

applications.
Create a form

• Link the form to a newly created бот or an existing бот using the Bot editor interface.
Add a form to бот

3. Add triggers to the бот:
Trigger loop enables you to add triggers that can run a task automatically when certain predefined
events occur.
Adding a trigger to run a бот

Сведения о AARI Assistant
Attended Bot Runner users can use the AARI Assistant application to access боты without logging into
Control Room.
Control Room administrator adds Active Directory (AD) users by selecting AD domain, providing
environment details, and assigning a role and device license. Administrator can further deploy the Control
Room RBAC by specifying role-based privileges and permissions at the боты and Bot Runner level.
Control Room RBAC on Bot Runner users facilitate a complete isolation based on pre-defined criteria such
as users across various business units or departments. This also includes the privileges that is applied at a
folder level to completely and seamlessly isolate боты of one department from the other.
In a typical scenario, triggering some specific боты to complete important tasks can be one of the
daily routines for attended Bot Runner users. Entire process of signing into Control Room can be time
consuming. AARI Assistant reduces this effort considerably. When Bot Agent is installed on a device, an
application shortcut on the desktop for AARI Assistant is also created along with a Start menu icon.
Users with attended Bot Runner license can launch this application, use their AD credentials to sign in and
review the list of available боты, and run the specific бот.

Важное замечание:  AARI Assistant application is not available for the Citizen Developer license.

Sign into AARI Assistant
Use the AARI Assistant application to directly run the боты without signing into Control Room.
• Automation Anywhere AARI service must be running in Control Room to use AARI Assistant.
• This application is designed only for user with attended Bot Runner license. A sign in error is displayed

if users with any other license tries to sign in.

1. Click the AARI icon to open AARI Assistant.
2. Use Automation 360 credentials to sign into the application.

All the боты that you have access to are listed.
3. Необязательно: Use the Search bar at the top to find a бот.
4. Необязательно: Click Show pinned only check box to list your pinned боты.

Ensure you pin (similar to favorites) the most used боты for a quick access.
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5. Click Launch to run the бот.
After the бот run is successful, a Completed message is displayed. You cannot launch another бот
until this activity completes.

AARI Assistant automation activities
As an attended user who runs attended боты, you can perform several automation activities using AARI
Assistant.

Automations page overview

In AARI Assistant, you can view a list of available боты for you to run in the Automations page.
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You can resize the page to fit your screen and have its contents automatically adjust.
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From the Automations page, you can also pin, sort, or search for боты.

Key features

Continue pending automation You can continue any pending automation that you
started from different AARI Assistant instances. If
you start an automation from one instance and then
reconnect to continue the automation on another
instance, the automation will process.
This provides a consistent automation experience
no matter which instance you use to access AARI
Assistant.

Consistent state AARI Assistant will remain in a consistent state
regardless of how many AARI Assistant instances
you use. The state will be updated to the latest
state across all AARI Assistant instances.

View and run any available bots To view and run any available боты, simple click
Start to start the automation.

View status or control bot progress in one
page

After you run a бот, you can view its progress in
real time.
You can also pause, start (resume), or stop the бот
progress.
By presenting the status and бот controls on one
unified page, this ensures consistency for each бот
run.
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Прим.:  To use the бот controls, you must have
the Managed my activity permission. Otherwise,
you can view the controls only.

View detailed status You can view the details of a бот status .
For example, you can use the details to
troubleshoot the automation if an error occurs.
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Using interactive forms
Interactive forms enable you to build forms for submitting and regrouping data that is used to send and
receive information from various applications within your attended automation process.
Interactive forms provide a list of actions that you can drag into a бот as a task logic. Specific function
of each action is displayed when you hover over them. The actions within the interactive forms can be
broadly classified into the following types:

Form level actions Represented by  and used within a task logic to
manage the linked form.

Element level actions Represented by  and used to manage elements
of a form.

Watch the following video to understand how to use Interactive forms in Automation 360:

Create a form
The form builder in Automation 360 enables you to create or edit forms using various form elements
available through a browser interface. A form provides structural content with little or no changes in the
layout. You can link a form to боты that perform predefined automated tasks.
The form builder requires no additional installation over the Bot Agent. Control Room users with the Bot
Creator license can access the form builder to design a new form or edit an existing form.
This task provides an example scenario where you create a new user registration form that captures all
the necessary information. When you link this form to a бот, it can trigger a third-party application to store
user information.
The form builder includes the following features:
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• The title of your form can be changed with a double-click.
• You can now add elements directly to the form builder without the need to add a column for each

element. The elements will dynamically resize to fit the canvas
• You can add up to 25 elements in a form.
• The width of the elements will automatically adjust in the form builder, depending on the number of

elements that you add.
• You can also adjust the width of your elements when you click and drag a corner of an element.
• The minimum width of the element is greater than 20.

1. На левой панели щелкните Автоматизация.
Отобразится список доступных  и форм.

2. Click Create a form.
3. На странице Создание формы введите имя для новой формы.

По умолчанию формы сохраняются в папке \Bots\. Щелкните Обзор, чтобы изменить папку по
умолчанию.

4. Щелкните Создать и редактировать.
The form builder page appears with a single row Column layout.

5. Use the Properties tab on the right to update or change the form properties.
a) Enter the title in the Form title field.
b) Use the Formatting fields to set the display font or the font size of the form elements.

Прим.:  Use the Font name drop-down menu to select an English-only font.
If you have used any of the supported non-English languages for the form elements, select Font
name > System default. For example, if you added an element label or text in Japanese,
select Font name > Medium for the form elements to be displayed in Japanese during the бот
runtime.

c) Use the Dimensions field to set the width and height of the form.
d) Use the Display behaviors field to set the way the form is displayed on the user desktop.
e) Необязательно: Use the Logos in footer field and select one of the following tabs:

• One Logo
Click Select File and use the Search, Browse, or Upload tabs to select an image file. The
selected file is displayed in the footer of the form during бот runtime.

• Two Logos
Click the two separate Select File options to select two image files. The selected files are
displayed in the footer of the form during бот runtime.

f) Set a variable using Hidden elements.
For example, if the registration form is linked to a Social Security Number (SSN) that cannot be
displayed to users, select the hidden element Type as Number. A user with a Bot Creator license
can then access this variable when creating a бот.
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6. Необязательно: Щелкните Предварительный просмотр.
The form preview screen enables you to view the display resolution of the form and change the form
position on the your desktop. You can select a resolution in the Display Resolution option.

You can either enter the values for the X and Y coordinates or drag the form using the cursor to
update the corresponding X and Y coordinates dynamically.
The Make form preview centered option lets you center the form.
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7. In this scenario, drag the following elements into the form:
a) Textbox: Enter First Name in the Element label field of the first text box, and enter Last

Name in the Element label field of the second text box.
b) Число. Enter Contact Number in the Element label field.

For a new user registration form, some of the fields such as contact number might be mandatory.
Use the Advance behaviors to make it mandatory and the Formatting option to set the input
format.

c) Radio Button: Update the Element label as Gender. Change the values for the
Radiobutton1 as Male and Radiobutton2 as Female.

d) Date: Enter Date of Birth in the Element label field.
e) Textbox: Enter Email ID in the Element label field.
f) Выпадающее меню. Update the Element label as Newsletter. Enter Daily, Weekly,

Monthly, or None in the Add dropdown content field.
In this scenario, you can use the Dropdown element to create a newsletter option for the new
user. This can be used to trigger an email based on the selected option.

g) Кнопка. Enter Submit in the Button-text (required) field.
h) Drag another Button element and enter Cancel in the Button-text (required) field.

Use the Button type drop-down menu and set this as Secondary.

8. Необязательно: Щелкните Предварительный просмотр.
Используйте эту функцию для предварительного просмотра внешнего вида формы с учетом
разрешения целевого устройства.

9. Щелкните Сохранить.
Новая регистрационная форма создана и готова к привязке к бот.

Использование элемента «Кнопка»
Используйте элемент Кнопка в конструкторе форм для проверки или отмены формы во время
выполнения бот.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Перетащите Кнопку в форму.
4. Введите имя элемента в поле Кнопка-текст.
5. Необязательно: Введите текст подсказки и всплывающую подсказку.
6. Используйте раскрывающееся меню Типы кнопки, чтобы задать тип элемента кнопки.

Например, предположим, что у вас есть две кнопки, «Сохранить» и «Отменить». Используйте
Основная для кнопки «Сохранить» и Второстепенная для кнопки «Отменить». Или, если вы
хотите, чтобы элемент кнопки отображался в виде ссылки во время выполнения бот, выберите
Незаметная.
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7. Необязательно: Используйте параметр Опережающее поведение.
• Запретить нажатие кнопки сразу после загрузки формы. Включите этот параметр,

чтобы отключить элемент кнопки при первом отображении формы во время во время
выполнения бот.

• Подтвердить все поля формы при нажатии этой кнопки. Включите этот параметр
для проверки всех доступных полей формы, когда пользователь щелкает по этому элементу
кнопки во время выполнения бот.

8. Необязательно: Щелкните один из следующих вариантов.
• Сброс. Очистка всех настроек элемента и установка значения по умолчанию.
• Удалить. Удаление выбранного элемента.

9. Щелкните Сохранить.

Using the Checkbox element
Use the Checkbox element in the form builder to enable users to select multiple options in a form during
бот runtime.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Drag Checkbox into the form.
4. Введите имя элемента в поле Ярлык элемента.
5. Необязательно: Enter the hint text and tooltip for the check box element.
6. Use the Checkbox content fields to add multiple check boxes and enter a name for each one of

them.
For example, if you are creating a sales chart form, use this field to add three check boxes and enter
Product 1, Product 2, and Product 3.

7. Необязательно: Enable any of the following Advance behavior options:
• Select the Make field required check box to ensure users select this element during бот runtime.
• Select the Make field uneditable check box to make the element a read-only option.
• If you have multiple check boxes in the form and want a default selection during бот runtime,

select the Make default selections check box, and select the necessary option.

8. Use the Formatting field to set the vertical or horizontal layout of the check boxes.
9. Необязательно: Щелкните один из следующих вариантов.

• Сброс. Очистка всех настроек элемента и установка значения по умолчанию.
• Удалить. Удаление выбранного элемента.

10. Щелкните Сохранить.

Using the Date element
Use the Date element in the form builder if the user must schedule a date in the form during бот runtime.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

© 2023 Automation Anywhere. All rights reserved.     2207



    Automation Anywhere - Сборка

Откроется страница конструктора форм.
3. Drag Date into the form.
4. Введите имя элемента в поле Ярлык элемента.
5. Select a default date using the Default value field.
6. Необязательно: Установите флажок Использовать местную системную дату при загрузке

формы, чтобы установить системную дату в качестве значения по умолчанию.
7. Select one of the following formatting options:

• Use locale date format setting: The date is displayed in the format set on the user's machine.
• Manual input: Select the date format to be displayed from the drop-down menu.

8. Enter the hint text and tooltip for the formatting option.
9. Необязательно: Enable any of the following Advance behavior options:

• Select the Make field required check box to ensure users select this element during бот runtime.
• Select the Make field uneditable check box to make the element a read-only option.

10. Необязательно: Щелкните один из следующих вариантов.
• Сброс. Очистка всех настроек элемента и установка значения по умолчанию.
• Удалить. Удаление выбранного элемента.

11. Щелкните Сохранить.

Using the Document element
Use the Document element in the form builder to render a document, such as an image (.jpg) or PDF,
that you want to preview along with the form.

Прим.:  Only one Document element can be used in a form.

1. На левой панели щелкните Автоматизация.
Отобразится список доступных  и форм.

2. Click an existing form or click Create new > Form.
Откроется страница конструктора форм.

3. Drag Document into the form.
4. Enter the correct URL or the document location address in the Default file field.
5. Use the Formatting drop-down menu to set the position of the document element in the form.
6. Необязательно: Enter a specific width for the element in the Dimensions field.
7. Необязательно: Щелкните один из следующих вариантов.

• Сброс. Очистка всех настроек элемента и установка значения по умолчанию.
• Удалить. Удаление выбранного элемента.

8. Щелкните Сохранить.

Using the Dropdown element
Use the Dropdown element in the form builder to provide multiple options in the form during бот
runtime.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
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2. Click an existing form or click Create new > Form.
Откроется страница конструктора форм.

3. Drag Dropdown into the form.
4. Введите имя элемента в поле Ярлык элемента.
5. Необязательно: Enter the hint text and tooltip for the check box element.
6. Use the Add dropdown content field to enter the items that must appear in the drop-down menu

during бот runtime.
7. Необязательно: Enable any of the following Advance behavior options:

• Select the Make field required check box to ensure users select this element during бот runtime.
• Select the Make field uneditable check box to make the element a read-only option.
• If you have multiple items in the drop-down element and want a default selection during бот

runtime, select the Select default list item check box, and select the necessary option.

8. Необязательно: Щелкните один из следующих вариантов.
• Сброс. Очистка всех настроек элемента и установка значения по умолчанию.
• Удалить. Удаление выбранного элемента.

9. Щелкните Сохранить.

Using the Dynamic Area element
Use the Dynamic Area element in the form builder to display content that is not part of the form itself
during бот runtime.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Drag Dynamic Area into the form.
4. Введите имя элемента в поле Ярлык элемента.
5. Use the Placeholder text field to enter the text that must appear if this element is empty during бот

runtime.
6. Введите высоту элемента в поле Высота.

Значение размера по умолчанию установлено на 120 и включает полосу прокрутки, если
дополнительное содержимое превышает это значение.

7. Необязательно: Щелкните один из следующих вариантов.
• Сброс. Очистка всех настроек элемента и установка значения по умолчанию.
• Удалить. Удаление выбранного элемента.

8. Щелкните Сохранить.
The Dynamic Area action is available during бот runtime to render this field.
См. раздел Interactive forms пакет.

Using the Select File element
Use the Select File element in the form builder to enable users to attach a file to the form. For example, if
the registration form requires a new user to attach a photograph, you can use this element in the form.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
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2. Click an existing form or click Create new > Form.
Откроется страница конструктора форм.

3. Drag Select File into the form.
4. Введите имя элемента в поле Ярлык элемента.
5. Use the Select the format type field to set one of the following options for upload file format:

• Supported Type: If you select this option, in the Enter file formats separated by commas
field, ensure that you enter the file types that the user can upload when the бот runs. For
example, if you want to allow only .png and .jpeg file types, enter them in the Enter file
formats separated by commas field.

• Unsupported Type: If you select this option, in the Enter file formats separated by commas
field, ensure that you enter the file types that will not be supported during upload when the бот
runs. For example, if you want to restrict users from uploading .txt and .ppt file types, enter
them in the Enter file formats separated by commas field.

6. Необязательно: Select Enable file download if you want the users to be able to download the file.
7. Необязательно: Enter the hint text and tooltip for the element.
8. Необязательно: Choose one of the following Advance behavior options:

• Select the Make field required check box to ensure users must select this element during бот
runtime.

• Select the Make field uneditable check box to set the element as a read-only option.

9. Необязательно: Choose one of the following options:
• Сброс. Очистка всех настроек элемента и установка значения по умолчанию.
• Удалить. Удаление выбранного элемента.

10. Щелкните Сохранить.
When you click Preview during бот runtime, the system default application is used to display the
selected file.
For example, if Microsoft Excel is set as the default application and you use Select file to upload a
.xls spreadsheet, the selected document is displayed in Microsoft Excel when you click Preview
during бот runtime.
Users can click Browse to select a file or drag a file into the Select File element during бот runtime.

Using the Select Folder element
Use the Select Folder element in the form builder to enable users to upload a folder that contains a
specified file type during бот runtime.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Drag Select Folder into the form.
4. Введите имя элемента в поле Ярлык элемента.
5. Необязательно: Select the Show list of supported files in the folder check box.

If you select this option, the supported file types are displayed below the Select folder form element
during бот runtime.

6. Enter the supported file types for this element during бот runtime.
For example, if you want to allow users to only upload folders that contain documents or text files,
enter doc and txt.
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7. Необязательно: Enter the hint text and tooltip for the element.
8. Необязательно: Choose one of the following Advance behavior options:

• Select the Make field required check box to ensure users must select this element during бот
runtime.

• Select the Make field uneditable check box to set the element as a read-only option.

9. Щелкните Сохранить.
Users can click Browse to select a folder or drag one into the Select Folder element during бот
runtime.

Using the Hyperlink element
Use the Hyperlink element in the form builder if you want to assign a URL during бот runtime.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Drag Hyperlink into the form.
4. Enter the text to be displayed for the URL in the Display text field.
5. Enter the link in the URL field.
6. Use the Open in browser drop-down menu to select a browser to open the URL.

If you select Google Chrome, the URL opens in Google Chrome during бот runtime.
7. Необязательно: Enter the hint text and tooltip for the check box element.
8. Щелкните Сохранить.

Using the Image element
Use the Image element in the form builder to enable users to attach an image file to the form. For
example, you can use this element to add a company logo to the form during бот runtime.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Drag Image element into the form.
4. Enter the id in the Element ID field.
5. Введите имя элемента в поле Ярлык элемента.
6. Необязательно: Enter a value in the Height field to adjust the height.
7. Необязательно: Add a help text.

• Enter a text in Hint below field.
• Enter a text in the Tool tip field.

8. Use the Desktop or network path to retrieve image field to specify the image filepath
9. Upload an image in the Select image file to upload field.

Прим.:  In Automation 360 v.26, where you must specify a local image for the Image element
(Desktop or network path to retrieve image field), you must use the browse feature in the image
property to upload the image.
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10. Щелкните Сохранить.

Использование элемента «Метка»
Используйте элемент Метка в конструкторе форм, чтобы добавить в форму поле только для чтения
во время выполнения бот.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Перетащите Метка в форму.
4. Введите имя элемента в поле Ярлык элемента.
5. Щелкните выпадающее меню Форматирование, чтобы применить эффект форматирования к

элементу.
• Размер шрифта. Установите размер шрифта.
• Выделение. Установите полужирный шрифт, курсив и так далее.
• Цвет шрифта. Установите цвет шрифта.
• Выравнивание текста. Установите выравнивание текста внутри элемента.
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6. Необязательно: Введите подсказку, которая появляется, когда пользователь наводит курсор на
элемент.

7. Щелкните Сохранить.

Using the Number element
Use the Number element in the form builder if the form must have a field that allows the user to enter
only numeric values during бот runtime.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Drag Number into the form.
4. Введите имя элемента в поле Ярлык элемента.
5. Set the default value for the element.
6. Enter the minimum and maximum number of characters that users can enter in this field during бот

runtime.
7. Необязательно: Enter the hint text and tooltip for the check box element.
8. Необязательно: Enable any of the following Advance behavior options:

• Select the Make field required check box to ensure users select this element during бот runtime.
• Select the Make field uneditable check box to make the element a read-only option.

9. Use the Formatting options to enable users to enter negative values, trailing zeroes, and comma
during бот runtime.

10. Используйте выпадающее меню Десятичные, чтобы указать количество знаков после запятой.
11. Используйте поле Специальные символы, чтобы ввести метки префикса и суффикса для

элемента.
12. Необязательно: Щелкните один из следующих вариантов.

• Сброс. Очистка всех настроек элемента и установка значения по умолчанию.
• Удалить. Удаление выбранного элемента.

13. Щелкните Сохранить.

Using the Password element
Use the Password element in the form builder if the form must have a confidential or masked field. This
element uses the masking feature by default and Credential Vault encryption to transfer data during бот
runtime.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Drag Password to the form.
4. Введите имя элемента в поле Ярлык элемента.
5. Используйте поле Форматирование, чтобы установить дополнительные параметры:

• Standard
• Установите ограничение на число символов для пароля с помощью полей Мин и Макс.
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• Включите дополнительные параметры безопасности для пароля.

• Custom
• Щелкните параметр Добавить регулярное выражение и введите пользовательский

пароль в поле Регулярное выражение.
• Необязательно. Enter the same custom password in the Test Content field, and click Test

regular expression to verify it works correctly.

6. Необязательно: Введите текст подсказки и всплывающую подсказку.
7. Необязательно: Enable any of the following Advance behavior options:

• Select the Make field required check box to ensure users select this element during бот runtime.
• Select the Make field uneditable check box to make the element a read-only option.

8. Необязательно: Щелкните один из следующих вариантов.
• Сброс. Очистка всех настроек элемента и установка значения по умолчанию.
• Удалить. Удаление выбранного элемента.

9. Щелкните Сохранить.

Прим.:  Use the view icon in the Password field to review the password during бот runtime.

Using the Radio Button element
Use the Radio Button element in the form builder if you want to enable users to select only one of the
available options from a field during бот runtime.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Drag Radio Button into the form.
4. Введите имя элемента в поле Ярлык элемента.
5. Необязательно: Enter the hint text and tooltip for the check box element.
6. Enter the names of the radio buttons that will be displayed during бот runtime.

Например, если вы создаете форму информации о клиенте, используйте это поле для
добавления двух переключателей и введите Мужчина и Женщина.

7. Enable any of the following Advance behavior options:
• Select the Make field required check box to ensure users select this element during бот runtime.
• Select the Make field uneditable check box to make the element a read-only option.
• If you have multiple radio buttons in the form and want a default selection during бот runtime,

select the Make default selections check box, and select the necessary option.

8. Use the Formatting field to set the vertical or horizontal layout of the radio buttons.
9. Необязательно: Щелкните один из следующих вариантов.

• Сброс. Очистка всех настроек элемента и установка значения по умолчанию.
• Удалить. Удаление выбранного элемента.

10. Щелкните Сохранить.
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Using the Rich Text Editor element
Use the Rich Text Editor element in the form builder to insert a text editor in the form that provides
various options to edit the content during бот runtime.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Drag Rich Text Editor into the form.
4. Введите имя элемента в поле Ярлык элемента.
5. Set the default value for the element that must appear in the element during бот runtime.
6. Enter the minimum and maximum number of characters that users can enter in this field during бот

runtime.
7. Необязательно: Enter the height for the input area of the field and tooltip for the element.
8. Необязательно: Enable any of the following Advance behavior options:

• Select the Make field required check box to ensure users select this element during бот runtime.
• Select the Make field uneditable check box to make the element a read-only option.

9. Необязательно: Щелкните один из следующих вариантов.
• Сброс. Очистка всех настроек элемента и установка значения по умолчанию.
• Удалить. Удаление выбранного элемента.

10. Щелкните Сохранить.

Using the Snapshot element
Use the Snapshot element in the form builder to provide the users a screen capture option on the form
during бот runtime. The file is saved in the .jpg format.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Drag Snapshot into the form.
4. Введите имя элемента в поле Ярлык элемента.
5. Необязательно: Enter the hint text and tooltip for the check box element.
6. Необязательно: Choose one of the following Advance behavior options:

• Select the Make field required check box to ensure users must select this element during бот
runtime.

• Select the Make field uneditable check box to set the element as a read-only option.

7. Enter a filepath in the Desktop path to save snapshot field where the snapshot file must be saved
during бот runtime.
Optionally, you can either allow the user to create a folder if the filepath is not available or change the
destination folder of the snapshot file.

8. Введите текст суффикса для файла снепшота.
For example, if this element is used to capture sales information, enter Sales. The snapshot file is
then saved with the text Sales added at the end.

9. Необязательно: Choose one of the following options:
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• Сброс. Очистка всех настроек элемента и установка значения по умолчанию.
• Удалить. Удаление выбранного элемента.

10. Щелкните Сохранить.
When you click Preview during бот runtime, the system default application is used to display the
snapshot file.
For example, if Microsoft Photos is set as the default application to open .jpg files, the snapshot file
is displayed in Microsoft Photos when you click Preview.

Использование элемента «Таблица»
Используйте элемент Таблица в конструкторе форм для вставки в форму настраиваемой таблицы,
которая может использоваться для заполнения данных во время выполнения бот.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Перетащите Таблицу на форму.
4. Введите имя элемента в поле Ярлык элемента.
5. Необязательно: Введите текст подсказки для элемента.

Например, введите Просмотр сведений об амбулаторных пациентах, если таблица
используется для получения списка амбулаторных пациентов.

6. Используйте поле Строки перед прокруткой, чтобы указать минимальное количество строк,
которое должно быть у элемента таблицы, прежде чем будет добавлена полоса прокрутки во
время выполнения бот.

7. Добавьте или удалите общее количество столбцов.
8. Щелкните Настройки столбца для получения дополнительных опций.
9. На странице Настройки столбца щелкните выпадающее меню Тип элемента формы, чтобы

задать тип элемента.
Например, если вы выберете Выпадающее меню, используйте поле Добавить контент в
выпадающем меню для ввода элементов, которые должны появиться в выпадающем меню во
время выполнения бот.

10. Необязательно: Щелкните Сделать ширину столбцов одинаковой.
11. Необязательно: Выберите любой из следующих параметров Опережающее поведение, чтобы

включить их.
• Сделать таблицу недоступной для редактирования. Активирует режим просмотра

только для чтения во время выполнения бот.
• Включить команды таблицы. Позволяет пользователям добавлять, удалять и

редактировать строки таблицы во время выполнения бот.
Если с помощью действий с таблицей удалить все строки из таблицы, а затем добавить
новую строку, столбцы и строки таблицы окажутся неправильно выровненными. Перетащите
и измените размер любого столбца, чтобы изменить выравнивание.

• Включить фильтрацию столбцов. Позволяет пользователям искать и фильтровать
содержимое по всем доступным столбцам во время выполнения бот. Это улучшает поиск
содержимого, на которое ссылаются значения столбцов.

12. Щелкните Сохранить.
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Using the Text Area element
Use the Text Area element in the form builder to insert a text field in the form for users to enter
alphanumeric characters during бот runtime.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Drag Text Area into the form.
4. Введите имя элемента в поле Ярлык элемента.
5. Use the Default value field to enter the default text to be displayed in the element.
6. Enter the minimum and maximum number of characters that users can enter in this field during бот

runtime.
7. Enter the height for the input area of the field.
8. Необязательно: Enter the hint text and tooltip for the check box element.
9. Необязательно: Enable any of the following Advance behavior options:

• Select the Make field required check box to ensure users select this element during бот runtime.
• Select the Make field uneditable check box to make the element a read-only option.

10. Необязательно: Щелкните один из следующих вариантов.
• Сброс. Очистка всех настроек элемента и установка значения по умолчанию.
• Удалить. Удаление выбранного элемента.

11. Щелкните Сохранить.

Using the Text Box element
Use the Text Box element in the form builder to insert a text box in the form.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Drag Text Box into the form.
4. Введите имя элемента в поле Ярлык элемента.
5. Enter the default text that must appear in the element.

For example, if this field is used in a registration form, enter First name, which is displayed during
бот runtime.

6. Используйте поле Форматирование, чтобы установить дополнительные параметры:
• Standard

Установите ограничение на число символов с помощью полей Мин и Макс.
• Custom

• Щелкните параметр Добавить регулярное выражение и введите пользовательский
текст в поле Регулярное выражение.

• Необязательно. Введите тот же пользовательский текст в поле Проверить
содержимое и щелкните Проверить регулярное выражение, чтобы убедиться, что
оно работает правильно.
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7. Необязательно: Enter the hint text and tooltip for the element.
8. Enable any of the following Advance behavior options:

• Select the Make field required check box to ensure users select this element during бот runtime.
• Select the Make field uneditable check box to make the element a read-only option.
• Select the Mask data check box if you want the field to be masked by special characters when the

user enters data during бот runtime.

9. Необязательно: Щелкните один из следующих вариантов.
• Сброс. Очистка всех настроек элемента и установка значения по умолчанию.
• Удалить. Удаление выбранного элемента.

10. Щелкните Сохранить.

Using the Time element
Use the Time element in the form builder to set the time in the form during бот runtime.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click an existing form or click Create new > Form.

Откроется страница конструктора форм.
3. Drag Time into the form.
4. Введите имя элемента в поле Ярлык элемента.
5. Select a default time using the Default value field.
6. Необязательно: Select the Use the local system time when form is first displayed check box to

set your system time as the default value.
7. Use one of the following formatting options:

• Set the time to 12 Hours or 24 Hours format.
• Введите текст подсказки и всплывающую подсказку.

8. Необязательно: Enable any of the following Advance behavior options:
• Select the Make field required check box to ensure users select this element during бот runtime.
• Select the Make field uneditable check box to make the element a read-only option.

9. Необязательно: Щелкните один из следующих вариантов.
• Сброс. Очистка всех настроек элемента и установка значения по умолчанию.
• Удалить. Удаление выбранного элемента.

10. Щелкните Сохранить.

Добавление правил к элементам формы
Add conditional actions, such as If, And/Or, and Then, to various elements in a form by using rules.
Для элементовФлажок и Переключатель правила срабатывают, только если выбраны
соответствующие предустановки. Например, если форма имеет два взаимоисключающих параметра,
таких как Да и Нет, то правила, связанные с этими параметрами, срабатывают только при выборе
одного из двух параметров.

Внимание:  Правила не поддерживаются для указанных ниже элементов.
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• Динамическая область
• Гиперссылка
• Изображение
• Выберите файл
• Выбрать папку
• Снепшот
• Таблица

Прим.:  The change label action in the form rules now applies to the Button element. This
form rules will automatically apply to the button where you set the rules. The rules editor is
now applicable to the Table element. The rules editor and conditions applies for each individual
columns while any actions you set are applied for each row in the row level.

Рассмотрим сценарий создания формы входа/регистрации пользователя. Можно добавить правило к
одному из элементов формы, чтобы включить вариант как входа существующего пользователя, так
и регистрации первого пользователя.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Click Create new > Form.
3. На странице Создание формы введите имя для новой формы.

По умолчанию формы сохраняются в папке \Bots\. (Необязательно) Чтобы изменить папку по
умолчанию, щелкните Выбрать.

4. Щелкните Создать и редактировать.
5. В форму можно перетаскивать указанные ниже элементы.

• Выпадающее меню. В поле Ярлык элемента введите «Выбрать тип пользователя», а в
поле Добавить контент в выпадающем меню добавьте «Существующий пользователь» и
«Новый пользователь».

• Текстовое поле. Добавьте два элемента и назовите их «Имя пользователя» и
«Регистрация».

• Пароль. Добавьте один элемент.
• Кнопка. Добавьте два элемента и назовите их «Сохранить» и «Отменить».

6. На правой панели щелкните Правила формы > Добавить правило.
Этот вариант можно использовать для добавления правил к элементам формы. В этом сценарии
добавьте два правила.

7. Для Правила 1 обновите указанные ниже поля.
Правило 1 применяется, когда существующий пользователь пытается войти в систему. Если
пользователь щелкает Выбрать тип пользователя > Существующий пользователь,
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текстовое поле Регистрация становится недоступным. Меню Если позволяет задать указанные
ниже условия.
a) Выбрать тип пользователя в качестве условия элемента в первом выпадающем меню
b) Выбор во втором выпадающем меню
c) Существующий пользователь в третьем выпадающем меню

Прим.:  Условия Если поддерживаются для указанных ниже элементов.
• Выпадающее меню
• Флажок
• Переключатель
• Дата
• Время
• Гиперссылка

Меню Затем позволяет задать указанные ниже соответствующие действия.
a) The Register text box in the first drop-down menu

В этом поле перечислены все доступные элементы формы, для которых поддерживаются
правила. For the Dropdown element in the Then menu, you can use the Assign option to
append or overwrite values at бот runtime.

b) Отключить во втором выпадающем меню

8. On Rule1, click the vertical ellipsis

( )
for the following options:
• Добавить правило ниже. Добавление нового правила ниже Правила 1.
• Дублирующееся правило. Дублирование Правила 1.
• Удалить правило. Удаление Правила 1.

If you added more than one rule, the following additional options are enabled to toggle the rules:
• Переместить вверх
• Переместить вниз
• На самый верх
• В самый низ
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9. Для Правила 2 обновите указанные ниже поля.
Правило 2 применяется для нового пользователя. Если пользователь щелкает Выбрать тип
пользователя > Новый пользователь, то текстовые поля Имя пользователя и Пароль
становятся недоступны. Меню Если позволяет задать указанные ниже условия.
a) Выбрать тип пользователя в качестве условия элемента в первом выпадающем меню
b) Выбор во втором выпадающем меню
c) Новый пользователь в третьем выпадающем меню

Меню Затем позволяет задать указанные ниже соответствующие действия.
a) The User name text box in the first drop-down menu
b) Отключить во втором выпадающем меню
c) The Password text box in the third drop-down menu
d) Отключить в четвертом выпадающем меню

10. Необязательно: If you want to interchange the sequence of these two rules, drag Rule1 below
Rule2 or Rule2 above Rule1.
You can also click the ellipsis (…) next to Add rules to select one of the following options:
• Collapse all: Collapses the rules. Is enabled only if you have expanded any of the available rules.
• Expand all: Expands the rules.

11. Щелкните Сохранить.
Новая регистрационная форма создана и готова к привязке к бот.

Add a form to бот
Adding an existing form to a bot enables users to collaborate with боты. Use the necessary action items to
create a бот and build a task logic.
This task describes a scenario where you want to design a бот that triggers an existing New User
Registration form. A Hot key preset trigger starts the бот. An existing form that is linked to the бот is
displayed where the user enters the information.
• If the user clicks Submit, a User Agreement form is displayed.
• If the user clicks Cancel, User registration is canceled message is displayed and the бот is

terminated.

1. На левой панели щелкните Автоматизация.
Отобразится список доступных  и форм.

2. Щелкните Создать > Бот.
3. Введите имя для бот.

Все боты хранятся в папке \Bots. Щелкните Обзор, чтобы изменить папку.
4. Щелкните Создать и редактировать.

The бот builder pane is displayed that has Flow (default view), List and Dual view. You can drag the
required actions from the left pane to create a task.

5. In Triggers > Hot key, drag Hot key trigger into Drag a trigger here in the бот logic.
6. Set Ctrl and L as the hot key combination.
7. Use the Search actions field to find Interactive forms.
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8. Drag Display into the task logic.
You can use the display action to show the form when the бот is triggered. The display action
properties appear on the right.

9.
Click the create variable icon ( ) to create a variable.
You have to create a form variable by linking an existing form. This enables you to use the form
variable and the associated form across multiple instances.

Прим.:  The form variable can be linked only to forms created using the Control Room form builder.

10. On the Create variable screen, enter a name for the form variable you are creating.
11. Click Browse and select the New User Registration form.

This links the New User Registration form to the form variable that you are creating.
12. Click Create & select.

A new form variable is created. For any existing form variable, use the Form name drop-down menu
to select it.

13. Use the Search actions field to find Trigger loop and drag it to add event monitoring.
Event monitoring enables you to simultaneously set multiple events within the task logic of a бот.

14. Drag Handle into the Trigger loop.
Handle enables you to run an action by configuring a trigger in the Trigger loop: Handle for the
бот. You can set a trigger when a event occurs on the selected interface (selected application) or
when a user clicks the selected form element.

15. For this scenario, use the Trigger on drop-down menu to select INTERACTIVE FORMS > Form
trigger.

16. Click the Form name drop-down menu and select the New User Registration form.
This enables you to set a trigger for the Submit option of the New User Registration form.

17. Click the Form element drop-down menu and select Submit.
For the Button element of a form, the Select action trigger is set to Clicked by default. When the
user clicks Submit on the New User Registration form, it triggers the User Agreement form.

18. (Optional) Use Assigned to to create a variable.
You can use this variable to fetch various details for the element you have selected in the Form
element drop-down menu. This return value is either a string or number based on the element type
selected. For example, if you have selected the Date element, the return value is a string.

19. Search for Interactive forms and drag Display into Trigger loop: Handle.
20. Click the Form name drop-down menu and select User Agreement form.

The User Agreement form appears.
21. Search for Message and drag it into Trigger loop: Handle, after Interactive forms.

A successful registration message appears when the user clicks Submit.
22. Terminate the trigger by dragging Break into the Trigger loop.

Use Break to exit the current event loop and for actions where finishing a process is required.
23. Drag another Handle next to the Trigger loop: Handle.

This enables you to set a trigger for the Cancel option of the New User Registration form.
24. Click the Form element drop-down menu and select Cancel.
25. Search for Message and drag it into Trigger loop: Handle. Update the Enter the message to

display field as User registration is canceled.
When the user clicks Cancel on the New User Registration form, it triggers a User registration
is canceled message and terminates the бот.

26. Drag Trigger Loop > Break to terminate the loop.
27. Щелкните Сохранить.
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28. Click Run with triggers.
The Run with triggers sets the Hot key trigger to start the бот, which is Ctrl plus L combination
from the keyboard in this scenario.

Ссылки, связанные с данной
Interactive forms пакет
The interactive forms пакет contains actions that handle exceptions encountered by a бот. All the actions
performed by users on the interactive forms can be monitored to execute logic using subtasks.

Adding a trigger to run a бот
Add triggers that can automatically run the selected бот whenever a specific event occurs. For example,
clicking a specific button or using a combination of keystrokes.
Triggers integrate predefined events into your workflow and reduce the number of repetitive tasks that
users must perform. Attended automation in Automation 360 enables you to create unique triggers for
various applications. You can then use these triggers to start a бот.
Use one of the following types of triggers to start a бот:

Важное замечание:  Trigger are not supported for private workspace, the trigger functionality will not
work.

Эл. почта Starts a бот when a new email message is received
in the specified email service such as Microsoft
Outlook, Email server, or EWS server.

Файлы и папки Starts a бот when a predefined file or folder event
occurs. You can set one of the following options as
the trigger:
• When a new file or folder is created.
• When an existing file or folder is deleted.
• When a file or folder is renamed.
• When a file or folder is modified.

Hot key Starts a бот when a predefined combination of
keystroke is performed on the keyboard. You can
set a combination of the following keys as the
trigger:
• Control keys such as Ctrl, Alt, Windows logo key,

 and Esc.
• Keys with regular alphabetical (English)

characters.

Интерфейс Starts a бот when a predefined event occurs on the
selected user interface element. Some examples of
the predefined events are:
• User clicks a button.
• User opens or closes an application.
• User selects or clears a checkbox.
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Прим.:  When capturing an interface trigger in a
SAP application, ensure that both the Средство
записи and Interface trigger пакеты are from
Сборка 5933 or from a prior release.

Процесс Starts a бот when a predefined event occurs on
the selected Microsoft Windows process. Some
examples of the predefined events are:
• User starts a process.
• User stops or closes a process.

Служба Starts a бот when a predefined event occurs on
the selected service in Microsoft Windows. Some
examples of the predefined events are:
• Service starts or stops.
• User pauses the service.
• User resumes the service that was paused\.

Окно Starts a бот when a predefined event occurs on
the selected application window. An example for a
predefined event is when a user opens or closes an
application.

Ссылки, связанные с данной
Trigger loop пакет
The Trigger loop пакет enables you to run a series of actions when a trigger event occurs. You can insert
multiple trigger loops within a бот or nest one trigger loop within another trigger loop.

Add an email trigger
Starts a бот when a new email message is received from the predefined email service.
Connect the Control Room to one of the email services on your system and trigger the бот when you
receive a new email.
For email automation, you can use OAuth 2.0 to authenticate with the email server. To register your
application with the Microsoft identity platform, see Using Connect action for Эл. почта
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Щелкните Создать > Бот.
3. Введите имя для бот.

All the боты are stored under the \Bots folder. (Optional) Click Browse to change the folder.
4. Щелкните Создать и редактировать.
5. In the бот builder page, click Triggers > Email trigger.
6. Drag Email into Drag a trigger here.
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7. Use the Email trigger pane on the right to choose one of the following server types as the trigger for
your incoming emails:
Тип сервера Шаги

Microsoft Outlook Click Outlook.
Microsoft Outlook is set as the email service and the бот is triggered when
you receive a new email.
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Тип сервера Шаги

Сервер эл. почты Click Email server.
a. Enter the email service Host information.

For example, if you are using Office365 as your email service, enter
Outlook.office365.com.

b. Select IMAP or POP3.
IMAP and POP3 are protocols used to connect to the mail server that
enables you to read your emails through an email client.

Прим.:  The POP3 protocol has a known limitation where any new
calender invite can also trigger the бот.

c. Использовать безопасное подключение (SSL/TLS). Select
this option if you want to use a secure connection with the mail
server.

d. Enter the configured port number for your email server.
e. Select one of the following user authentication methods to sign in to

the email server:
• Basic

• Учетные данные. Click Pick to select the stored Username
and Password.
Credentials and credential variables in the Bot editor

• Insecure string: Enter the username and password.

• Client credentials
• Specify the unique client and tenant IDs generated when you

registered the application in the Microsoft Azure portal.
• Specify the username you want to use to access the mail server.
• Specify the client secret that you generated for your app in the

app registration portal.
For Client ID, Tenant ID, Username and Client Secret
fields, choose from Credential or Insecure string tab:
• Учетные данные. Use a value available in the credential

vault.
• Insecure string: Manually enter a value.

Прим.:  Client Credentials flow does not support Gmail.

Прим.:  The Email in folder does not support sub-folders when you
set the protocol as POP3 for Email Server,
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Тип сервера Шаги

Сервер EWS Click EWS server.
a. From the Microsoft Exchange Version drop-down menu, select

your current version.
For example, if you are using Microsoft Exchange Service Pack 2,
select Exchange2010_SP2 as your email service.

b. Enter the domain name, for example, smtp.office365.com
c. Select one of the following user authentication methods to sign in to

the email server:
• Basic

• Учетные данные. Click Pick to select the stored Username
and Password.
Credentials and credential variables in the Bot editor

• Insecure string: Enter the username and password.

• Client credentials
• Specify the unique client and tenant IDs generated when you

registered the application in the Microsoft Azure portal.
• Specify the username you want to use to access the mail server.
• Specify the client secret that you generated for your app in the

app registration portal.
For Client ID, Tenant ID, Username and Client Secret
fields, choose from Credential or Insecure string tab:
• Credential: Use a value available in the credential vault.
• Insecure string: Manually enter a value.

8. Необязательно: Use the Check every drop-down menu available under all the server types to set
the trigger interval.
The trigger interval for the бот is set to 120 seconds by default.

9. Необязательно: Use Select Conditions to specify an email event for the selected server type.
Consider a scenario where you select Outlook and want to trigger a бот when you receive an email
from a specific sender. In Select Conditions, select the Email from check box and specify the
sender's email address.
When you select the Email subject contains check box, the email trigger is executed depending on
the following subject conditions:
• Если тема письма заключена в двойные кавычки (""), например "электронная таблица

ABC", триггер срабатывает только в том случае, если тема сообщения имеет точное
совпадение со строкой, заключенной в кавычки.

• Если несколько строк темы разделены точкой с запятой, например электронная таблица
ABC; журналы проекта ABC, триггер срабатывает, когда тема сообщения совпадает с
любой из указанных тем.
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10. Необязательно: To create a variable, in the Assigned to > Record tab, click

.
You can use this variable to retrieve various details about the email that triggered the бот, such as
sender, recipient, subject, email content, date, action information, email server host, and port data.

11. Щелкните Применить.
12. Щелкните Запустить > Запустить с триггерами.

Microsoft Outlook, Email server, or EWS server is set as the trigger to start the бот for new emails.

Прим.:  When you run an email trigger, the emailTo key returns a list of To addresses. To convert the list
of To addresses into a string, use the Assign action from the Список пакет and then use the Join items
action from the Список пакет, with the comma as a delimiter to separate the addresses.

Add a file and folder trigger
Starts a бот when a predefined action such as create, delete, rename, or modify is performed on a file or a
folder.
This procedure is for a scenario where you want to trigger a бот when a user modifies a document called
Product info.docx.

Прим.:  This scenario is for a user with Bot Creator role.
For information about how a user with a Bot Runner role can link event triggers, see Связывание
триггеров событий с Bot Runner.

1. На левой панели щелкните Автоматизация.
Отобразится список доступных  и форм.

2. Щелкните Создать > Бот.
3. Введите имя для бот.

All the боты are stored under the \Bots folder. (Optiona0 Click Browse to change the folder.
4. Щелкните Создать и редактировать.
5. In the бот builder page, click Triggers > Files & folders.
6. Drag File trigger into Drag a trigger here.
7. Click Browse and select the Product info.docx file.
8. From the Start the bot when the file is drop-down menu, select modified.

This sets the trigger for the бот.
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9. Необязательно: Для назначения переменной используйте выпадающее меню Назначено для.
Чтобы для создания переменной использовать вкладку Переменные, убедитесь, что
установили флажок Использовать как ввод, чтобы эта настройка появилась в выпадающем
меню Назначено для (необязательно).

Прим.:  If you use the  in the Assigned to (optional) drop-down menu to create a variable,
ensure that you do not select the Constant (read only) check box.

The following set of data can be retrieved by defining a variable as the input type, which you can
assign to get output from the trigger:
• triggerType: File or folder trigger
• eventType: The type of trigger event

The following set of data cannot be used if the Set Schema check box is selected as it returns a non-
string variable type:
• timeStamp: The time when the trigger occurred

Ensure you link the timeStamp value to a string variable to obtain the trigger data. For example,
consider you want to extract the date and time for the trigger event when a user modifies the
Sales update.xls file. Use the Message action within the task logic, and enter Date Time-
 $recordVar[2]$ in the Enter the message to display field.

• fromFolder: Details of the parent folder path
• folder: Details of the file or folder path on which the event occurred

10. Щелкните Сохранить.
11. Щелкните Запустить > Запустить с триггерами.

Whenever a user modifies the Product info.docx, the бот is triggered.

Ссылки, связанные с данной
Триггеры события
An event trigger is a predefined action that runs an associated бот. All the боты with event triggers are
listed under the Event triggers tab.

Add a hot key trigger
Starts a бот when a predefined combination of keys is used on the keyboard.
This procedure is for a scenario where the бот is triggered when a user presses Ctrl (plus) L keys from the
keyboard.

Прим.:  Hot key triggers are supported on both attended and unattended Bot Runner licenses. However,
the hot key trigger will work for unattended Bot Runner users only if they have access to the associated
default device and they use the predefined keys.

1. На левой панели щелкните Автоматизация.
Отобразится список доступных  и форм.

2. Щелкните Создать > Бот.
3. Введите имя для бот.

All the боты are stored under the \Bots folder. (Optional) Click Browse to change the folder.
4. Щелкните Создать и редактировать.
5. In the бот builder page, click Triggers > Hot key.
6. Drag Hot key trigger into Drag a trigger here.
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7. Click Ctrl to set it as the Hot key from the available key modifiers.
8. Use the drop-down menu to select L from the keyboard.

The Hot key field displays the key combination that will trigger the бот.
9. Щелкните Применить.
10. Щелкните Запустить > Запустить с триггерами.

When the Ctrl and L keys are used on the keyboard, the бот is triggered.

Add an interface trigger
Starts a бот when a predefined action occurs on a specific interface element, such as clicking a button or
closing an application.
The following procedure is for a scenario where you want to configure a trigger to start a бот when the
user clicks New option in Microsoft Word. Before you configure the trigger, ensure that you have the
Microsoft Word application open on your system.

Прим.:  Interface triggers for objects are available only for native Windows applications.

Прим.:  Interface triggers are supported on both attended and unattended Bot Runner licenses. However,
the interface trigger will work for unattended Bot Runner users only if they have access to the associated
default device and perform the predefined action on the specified interface element.

1. На левой панели щелкните Автоматизация.
Отобразится список доступных  и форм.

2. Щелкните Создать > Бот.
3. Введите имя для бот.

Все боты хранятся в папке \Bots. (Optional) Click Browse to change the folder.
4. Щелкните Создать и редактировать.
5. In the бот builder page, click Triggers > Interface trigger.
6. Drag Object into Drag a trigger here.

The Interface trigger: Object editing panel appears.
7. In Window detail tab, click Application.

Прим.:  For browser-based events, click Browser and select the correct browser tab. Interface
triggers are supported on only Google Chrome and Edge Chromium browsers.

8. Click the drop-down menu and select Taskbar under Preset.
If Microsoft Word is not displayed in the list, you can use the Refresh option to reload the list of
applications.

9. Click Capture object.
This initiates a built-in web recorder that captures the action. In this scenario, Microsoft Word is
displayed. Click New, which is then set as the trigger to start the бот.

10. Click the Select main event drop-down menu to choose a specific event.
In this scenario, New in Microsoft Word is considered a button and the following events are available:
• Click: Triggers the бот when the user clicks the selected main event object.
• Click with hotkey: Use one of the available key modifiers and select a key (alphabetical letters)

from the drop-down menu. This combination is set as the hot key to trigger the бот.

11. Необязательно. Select one of the available Control keys (Shift, Alt, Ctrl, Windows and AltGr) as an
additional combination for the hot key to trigger the бот.
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12. Щелкните Сохранить.
13. Щелкните Запустить > Запустить с триггерами.

The preset trigger is created, and the бот is triggered when the user clicks New in Microsoft Word.

Добавление триггера процесса
бот запускается, когда в выбранном процессе Microsoft Windows выполняется предопределенное
действие.
Эта процедура предназначена для сценария, в котором требуется настроить триггер, чтобы
запускать бот, когда пользователи запускают или закрывают Microsoft Outlook. Перед настройкой
триггера процесса убедитесь, что в системе открыто приложение Microsoft Outlook, чтобы можно
выбрать этот процесс.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Щелкните Создать > Бот.
3. Введите имя для бот.

Все боты хранятся в папке \Bots. (Optional) Click Browse to change the folder.
4. Щелкните Создать и редактировать.
5. In the бот builder page, click Triggers > Process trigger.
6. Перетащите Процесс в область Перетащите триггер сюда.

Триггер процесса.Отображается панель редактирования процессов.
7. Click the Process name drop-down menu and select Outlook.exe.

Если ни один из процессов не указан в списке, обновите выпадающее меню Имя процесса.
8. Select the following check boxes to set the trigger condition:

• Запускается. бот запускается, когда пользователи запускают Microsoft Outlook.
• Останавливается: бот запускается, когда пользователи закрывают или останавливают

Microsoft Outlook.

9. Необязательно: Для назначения переменной используйте выпадающее меню Назначено для.
If you want to use the Variables tab to create a variable, ensure that you select the Use as input
check box for it to appear in the Assigned to (optional) drop-down menu.

10. Щелкните Сохранить.
11. Щелкните Запустить > Запустить с триггерами.

Создается предустановленный триггер, который запускает бот, когда пользователи запускают
или закрывают приложение Microsoft Outlook.

Добавление триггера службы
бот запускается, когда с выбранной службой в Microsoft Windows выполняется любое из
предопределенных действий.
Эта процедура предназначена для сценария, в котором требуется настроить триггер, чтобы
запускать бот, когда служба Обновление Windows запускается, останавливается или
приостанавливается пользователем.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Щелкните Создать > Бот.
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3. Введите имя для бот.
Все боты хранятся в папке \Bots. (Optional) Click Browse to change the folder.

4. Щелкните Создать и редактировать.
5. In the бот builder page, click Triggers > Service trigger.
6. Перетащите Служба в область Перетащите триггер сюда.

Триггер службы.Отображается панель редактирования служб.
7. Щелкните выпадающее меню и выберите Обновление Windows.

Если ни одна из служб не указана в списке, обновите выпадающее меню.
8. Чтобы задать условие срабатывания триггера для службы Обновление Windows, установите

указанные ниже флажки.
• Запускается
• Останавливается
• Приостанавливается

9. Необязательно: Для назначения переменной используйте выпадающее меню Назначено для.
Чтобы для создания переменной использовать вкладку Переменные, убедитесь, что
установили флажок Использовать как ввод, чтобы эта настройка появилась в выпадающем
меню Назначено для (необязательно).

10. Щелкните Сохранить.
11. Щелкните Запустить > Запустить с триггерами.

Создается предустановленный триггер, который активирует бот, когда какой-либо пользователь
запускает, останавливает или приостанавливает службу Обновление Windows.

Добавление триггера окна
бот запускается, когда пользователи открывают или закрывают предварительно определенное окно
приложения.
Эта процедура предназначена для сценария, в котором требуется настроить триггер, чтобы
запускать бот, когда любой пользователь открывает документ Microsoft Excel с названием
Customer_database.xls. Перед настройкой этого триггера окна обязательно откройте файл
Customer_database.xls в своей системе, чтобы можно было выбрать это окно.
1. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
2. Щелкните Создать > Бот.
3. Введите имя для бот.

Все боты хранятся в папке \Bots. (Optional) Click Browse to change the folder.
4. Щелкните Создать и редактировать.
5. In the бот builder page, click Triggers > Window trigger.
6. Перетащите Окно в область Перетащите триггер сюда.

Триггер окна.Отображается панель редактирования окон.
7. В выпадающем меню Окно выберите Customer_database.xls.

Если ни одно из доступных окон не указано в списке, обновите выпадающее меню Окно.
8. В поле Заголовок окна перейдите на вкладку Строка, чтобы задать заголовок выбранного

окна целиком.
Вкладку Регулярное выражение можно использовать для выбора шаблона, который
соответствует выбранному заголовку окна. Например, если в этом сценарии выбрать
Регулярное выражение, бот активируется, когда пользователь открывает любой файл .xls.
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9. Выберите Открыть в выпадающем меню Действие с окном, запускающее бот.
10. Необязательно: Для назначения переменной используйте выпадающее меню Назначено для.

Чтобы для создания переменной использовать вкладку Переменные, убедитесь, что
установили флажок Использовать как ввод, чтобы эта настройка появилась в выпадающем
меню Назначено для (необязательно).

11. Щелкните Сохранить.
12. Щелкните Запустить > Запустить с триггерами.

Создается предустановленный триггер, который активирует бот, когда какой-либо пользователь
открывает документ Customer_database.xls.

ServiceNow New Record trigger
Create a trigger to monitor a ServiceNow table for new records and begin succeeding RPA actions in your
бот flow.
• The бот creator must have access to a ServiceNow account with required permissions to perform tasks

enabled by this package. See Roles.
• Follow ServiceNow guidelines for authenticating to an external client with OAuth 2.0. See Set up OAuth.
• Create a Developer account and Developer instance in ServiceNow. See Personal Developer Instances.
• Ensure that you are authenticated before initiating any ServiceNow action. См. Аутентификация

The new record trigger monitors the creation event of any record within a time period. Upon record
creation, the trigger invokes and returns data. If multiple records are created within the entered time
period, then the trigger returns data of multiple records.
Map your trigger to a ServiceNow table, and then enter the time period to send a query for that table data.
When a new record is found, this trigger is invoked and begins succeeding бот actions.
1. Enter the URL for your ServiceNow instance.
2. (Optional) Enter the API version.
3. Select how ServiceNow credentials will be entered for the following fields.

Вариант Описание

Credential Select a credential saved in a secure locker that
you have mapped to your Control Room.

Небезопасная строка Enter the credential.

a) Enter the Client ID.
b) Enter the Client secret.
c) Введите Имя пользователя.
d) Enter the Password.

4. Enter the Table name in ServiceNow to monitor for new records.
A query is sent, and ServiceNow returns data for this table. When a new record is returned in the
data, then this trigger is invoked.

5. (Optional) To store a response from ServiceNow, select and enter a List or Variable input where the
response is stored.

6. (Optional) Apply filters to specify the type of ServiceNow record to monitor.
7. Enter how frequent the trigger searches for new records in the Check every (seconds) field.
8. (Optional) Select a variable to save returned data by the trigger.
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ServiceNow Updated Record trigger
Create a trigger that monitors a ServiceNow table for updated records and begins succeeding RPA actions
in your бот flow.
• The бот creator must have access to a ServiceNow account with required permissions to perform tasks

enabled by this package. See Roles.
• Follow ServiceNow guidelines for authenticating to external client with OAuth 2.0. See Setup OAuth.
• Create a Developer account and Developer instance in ServiceNow. See Personal Developer Instances.
• Ensure that you are authenticated before initiating any ServiceNow action. См. Аутентификация

The updated record trigger monitors the record within a time period. When updates occur, the trigger
invokes and returns data. If multiple records are updated within the entered period, then data of multiple
records is returned.
Map your trigger to a ServiceNow table. Enter the time period to send a query for that table data. When an
updated record is found, this trigger is invoked and can begin succeeding бот actions.
1. Enter the URL for your ServiceNow instance.
2. Enter the API version.
3. Select how ServiceNow credentials will be entered for the following fields.

Вариант Описание

Credential Select a credential saved in a secure locker that
you have mapped to your Control Room.

Небезопасная строка Simply enter the credential. This data will remain
visible.

a) Enter the Client ID.
b) Enter the Client secret.
c) Введите Имя пользователя.
d) Enter the Password.

4. Enter the Table name where the record is located in ServiceNow.
This data is what the trigger monitors. A query is sent, and ServiceNow returns data for this table.
When a record update is returned in the data, then this trigger is invoked.

5. (Optional) To store a response from ServiceNow, select and enter a List or Variable input where the
response is stored.

6. (Optional) Apply filters to specify the type of ServiceNow record to monitor.
7. Enter how frequent the trigger searches for updated records in the Check every (seconds) field.
8. (Optional) Select a variable where returned data is saved by the trigger.

Example for using hot key to trigger a bot
In this example, a front desk executive of an insurance company responds to a call from an existing
customer who wants to understand the policy details and its validity. The executive uses a hot key to
trigger a бот that retrieves the customer's information.

Information about all the existing customers and the insurance company's various policies is distributed
across two different databases. An existing бот maps the data between the two databases and provides
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consolidated information in a user readable format to the executive. Ctrl+L is set as the hot key to trigger
this бот.
1. The executive collects caller's information to verify if it is an existing customer.

The executive confirms the caller is an existing customer who wants to know the policy details.
2. The executive uses Ctrl+L to trigger a бот.

The бот retrieves the customer information and the corresponding policy details. An authorization
message is displayed.

3. The executive reviews the information that is consolidated in a form, and answers the customer
queries without any delay or hold time.
The following image illustrates this attended automation scenario:

Embedded Automation
Access automated processes and боты from any platform with an embedded interface. Embedded
Automation delivers automation everywhere you want, either integrated with your web application or
delivered through a browser extension.

Why use Embedded Automation

Embedded Automation brings the power of AARI directly to any cloud environment or web application
packaged in an intuitive widget interface. The capability of Embedded Automation empowers end users
with essential access to data across platforms, delivered directly to their core interactive space. This data
access could be forms, applications, business history, and more. Whenever users need data, Embedded
Automation ensures that it is readily available.
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With automations a click away, there's little need to keep open an additional application in your workspace.
Automations can simply be embedded in the familiar space you spend the majority of time. With accessible
automations, users are able to quickly reach out, deliver data, keep a customer interaction engaging and
progressive, and reduce time spent waiting.

What you can do with Embedded Automation

There are many cases where users can leverage this ever-present access to launch automations and
processes in their familiar environment. The following are a few cases where Embedded Automation
improves workflow with streamlining and precision:

Fetch case data from user input or from
hosting data input

Access, complete, and submit forms with business
data onscreen in your web application. This further
empowers running attended боты that rely on
source context and visual cues while executing.

Launch automation with hosting data input While updating an account, business users can
run a бот that takes a sales order number, fetches
additional details as needed, and then pushes all
details into the system to immediately begin billing
for the sale.
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Orchestrate case resolution and business
workflow

Automated processes can guide agents through
a complex task involving management approval,
prompting and alerting team members during
process phases to expedite approval, and finally
enter customer and business data into a final
document rendered for official record.

Automate mundane local tasks Боты can upload sales leads or contact info from a
desktop spreadsheet to web applications with one
easy click.

Компоненты Embedded Automation

The two main components in Embedded Automation are as follows:

A widget within web application through
AARI Integrations

AARI Integrations embeds in web applications as
a widget. If you are an end user you can access
automated processes and боты without leaving
your environment. The widget is composed from an
HTML inline frame or simply an iFrame widget that
the user can configure and access in supported web
browsers.

An extension on Google Chrome browser
through AARI Extensions

AARI Extensions embeds in web applications as
a side panel rendered by an extension for Google
Chrome browser. As an end user, you can access
automated processes and боты without leaving
your environment. In addition, AARI Extensions
offers further adaptability through web page
customization, such as mapping an automation
to web elements, for example, a button. With
an OAuth 2.0 connection, existing access to
automations in the Control Room are now shared
with AARI Extensions to offer you a seamless user
experience.

The AARI admin has the key role of organizing access points for business users using Embedded
Automation.
For AARI Integrations, the iFrame widget embeds seamlessly into adjacent content of your web
application. The AARI admin must first set up and configure the iFrame widget details using AARI and then
assign automations to teams by adding specific members of a team and defining the team owners and
admins. After setup is completed business users can deploy automations in their web application using the
iFrame widget.
AARI Extensions has a similar setup process, differing in the way the widget is accessed, via an extension
for Google Chrome browser. Because of this difference, a developer has to enable web components for the
extension. Similar to AARI Integrations, the admin completes the setup and configuration of the iFrame
widget using AARI. Next, a бот creator develops a web component using a Page Editor, assisted by the
iFrame widget embed code, supplied in AARI. Newly created web components become visible within AARI
for Administrators to assign to teams. Assigned users will then navigate to their web application and access
the iFrame widget, while logged in to their Control Room.
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References

Learn more about the usages of AARI Integrations and AARI Extensions in AARI Integrations и AARI
Extensions.
Learn more about Automation Anywhere Robotic Interface (AARI) and its functions in Automation Anywhere
Robotic Interface (AARI).

AARI Integrations и AARI Extensions
Compare the two delivery methods of Embedded Automation to decide on the right component for your
business needs.
AARI is a platform for automation to assist business users with common workflows. Users can continue to
automate using AARI in their favorite web applications and CRM platforms, such as the ServiceNow service
portal. When you use AARI Integrations to set up your iFrame widget, you can now access AARI through
an embedded widget in your web application and deploy automations, all without the need to leave your
environment.

Comparing Embedded Automation components

As you explore AARI Integrations and AARI Extensions, they might seem very similar. They are both
solutions that provide your environment with an iFrame widget interface powered by AARI. The iFrame
widget hosts automations from AARI on the web, offering the same power of automating with Automation
360.
Either AARI Integrations or AARI Extensions can deliver Embedded Automation. However, depending on
where you aim to embed, one component might better suit your needs over the other.
Simply put, the decision to embed a widget in your environment relies on choosing one of the following.
• Integration: Add an iFrame to the source code of your web application.
• Extension: Develop custom bricks that are coded into your browser through an extension.

Consider technical specifications and styles of these components.

AARI Integrations

AARI Integrations embeds in web applications as an iFrame widget offering end-users access to automated
processes and bots without leaving their environment.
Consider the following prerequisites for using AARI Integrations:
• Automation 360 v.26 or later.
• Google Chrome, Microsoft Edge Chromium, or Apple Safari web browsers. См. раздел Требования к

браузеру для доступа к Рабочая область RPA.
• AARI licenses and fluency.
• AARI web interface.
• Web application that supports the iFrame widget.

For further details on how to start using AARI Integrations, click the image to navigate to the overview
topic:
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AARI Extensions

AARI Extensions relies on a Chrome extension of your web browser to embed automations. The widget
appears outside the application as an Automation Anywhere stylized panel, as in the following image.
Consider the following prerequisites for using AARI Extensions:
• Automation 360 v.26 or later.
• Google Chrome web browser.
• AARI licenses and fluency.
• OAuth 2.0 Control Room configuration for server validation.

For further details on how to start using AARI Extensions, click the image to navigate to the overview
topic:
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Обзор AARI Integrations
You can use a widget that embeds automations built on the Automation 360 platform that can be applied
natively on any supported web application.

Capabilities

iFrame widget A widget that is composed from an HTML inline
frame, or simply iFrame widget, can be used as
a "window" to access another website located
in your current web application environment. In
addition, the iFrame widget provides reliable and
secure methods of quick integrations performance
without the need for heavy development work,
when involved with custom integrations.
For example, your current web application
environment is domain 1, which can access a
widget that shows a website from domain 2. These
two domains exist in one shared environment,
without you navigating to a separate page or
window.
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iFrame widget experience on supported web
applications

The Automation 360 platform can support
embedding an iFrame widget on any web
application that supports the iFrame technology
to access external contents. Many software-as-
a-service (SaaS) web applications support the
iFrame widget to allow for customization in a secure
environment.
Business users can add contextual workflow
automations from inside their most used and
preferred enterprise applications. This approach
means that users need to add only minimal code
to their most used web applications, which when
applied can produce a rich, friendly, and more
secure interactive user experience.

Actions that can be performed with iFrame
widget

Business users can use iFrame widget to perform
the following:
• Invoke local automations on their desktop.
• Invoke multistep process workflows from AARI

requests.
• Monitor request progress to completion.
• Receive notification of pending tasks.
• Respond directly to pending tasks from iFrame

widget.
• View the history of currently running or

previously completed automations.

Requisites

• Ensure that you have the proper role and permissions. Создание пользователей для Automation
Anywhere Robotic Interface

• AARI license.
• Proper roles for AARI admin and user.

• Automation 360 v.26 or later.
• Google Chrome, Microsoft Edge Chromium, or Apple Safari web browsers. См. раздел Требования к

браузеру для доступа к Рабочая область RPA.
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• AARI web interface.
• Web application that supports iFrame technology.

Последовательность операций процесса

1. Set up your integrations and iFrame widget for a web application.
2. Assign automations to a team for them to access data from the iFrame widget.
3. Configure widget settings in a web application to properly access iFrame widget.
4. Deploy the iFrame widget.

Workflow map: Click the following schematic image to view the AARI Integrations workflow in an

interactive visual format:
1. AARI Integrations

Setup iFrame widget using AARI Integrations
You can define your integrations with iFrame widget for your supported web applications. This includes
creating a new integration, iFrame widget, and configuring the iFrame widget code.
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Убедитесь, что вы выполнили указанные ниже действия.
• Provided a system-created AAE_Robotic_Interface Admin role for the AARI admin.
• Have access to the AARI web interface.
• Complete any necessary password changes to access the AARI web interface.

For this task, you can create new integrations and configure your iFrame widget details including access to
the embed code for you to copy and use in a web application.

Важное замечание:  You can only setup integrations and iFrame widget details for web applications
that supports the iFrame widget. If the web application does not support the iFrame widget, refer to AARI
Integrations и AARI Extensions.

1. Log in to the AARI web interface.
2. Navigate to Manage > Integrations.

The Integrations Setup page appears for you to setup your connection. If this is your first time
accessing this page, you will see the No Integrations label.

3. Click Add Integrations to add a new integration.
4. Specify a name for the integration in the Name field.

You can name it Integrations or the name of your favorite web application to help you define the
web application that you plan to embed the iFrame widget.

5. Необязательно. Specify a description for your integration in the Description field.
6. Щелкните Создать и редактировать.

Your integrations is now created and forwards you to an Edit integration page that you can edit
your integration.

7. Navigate to the Widgets tab in the same page.
You can add iFrame widgets to your integration in this tab.

8. Щелкните по значку «плюс».
The Add Widget page prompts you to add a new iFrame widget to your integration.

9. Specify a name for the iFrame widget in the Widget name field.
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10. Specify your tags in the Filtered automations field.
You can select existing tags from the drop-down to add to the widget. When you add tags, they
display in the widget tab in the tags column next to the widgets.

11. Щелкните Сохранить.
You have now successfully defined a new iFrame widget for your integration.
You can now generate an iFrame code.

12. Click the three dots (ellipses) next to the name of your iFrame widget.
• Embed code option allows you to generate code for the iFrame widget.
• Edit option enables you to edit the iFrame widget details.
• Delete option will delete the iFrame widget.

13. Click Embed code option.
The Embed code window appears and prompts you configure the code details.

14. Specify the size of the iFrame widget width and height in the Widget width and Widget height
fields, respectively.

Прим.:  The default size of the iFrame widget width and height are 100 %. You can change %
(default) to px for pixels depending on your preference.
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15. Click Copy in the Embed code section to copy the code.

16. Необязательно. Click Email embed code if you would like to open your local mail client to email
the embed code to another individual.
You now have access to the iFrame widget code.

17. Щелкните Закрыть.
You have now successfully copied your iFrame widget code that can be used in a supported web
application.
For your next steps, you can assign automations to your team, see Assign automations to teams.

Assign automations to teams
You can configure teams to access automations and tasks for it to be accessed via the Desktop Assistant,
AARI web interface, and the iFrame widget embedded in other business applications.
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Убедитесь, что вы выполнили указанные ниже действия.
• Provided a system-created AAE_Robotic_Interface Admin role for the AARI admin.
• Have access to the AARI web interface.

1. Log in to the AARI web interface.
2. Assign members to a team.
3. Assign teams to a process.
4. Assign teams to a бот.

Your have now assigned automations for your team. Members of your team can now automate using
the iFrame widget.
For your next steps, you can configure the widget in a web application to access to automations in the
iFrame widget, see Configure iFrame widget in a web application.

Assign members to a team
You can follow this task to create a new team and assign members to your team.

1. Navigate to Manage > Teams.
The Team Setup page appears for you to create new or edit existing teams.

2. Click Create new team.
The Create a team window appears with details for you to edit.

3. Specify the name of the team in the Team Name field.
4. Specify a description for your integration in the Description field.
5. Select the AARI Manager option in the Team admin field.

The AARI manager will be the team admin that manages the user and their access.
6. Щелкните Создать и редактировать.

You will now be forwarded to the Edit team page where you can edit the team attributes.
7. Select the Shared or Private option in the Request Visiblity section.

• Shared option allows for all requests to be access by all member, owners, and team admins in the
team.

• Private option allows for the requests to be to be available to only the member who created the
request, owner, and team admin in the team.

8. Navigate to the Users tab.
9. Click the plus (+) icon to add a users to your team.
10. Select a user or users to be added.
11. Click Add & save.

You have now added one or more users to your team.
12. Щелкните Закрыть.

You have successfully added users to your team. You can now add automations to the team that
allows for members of your team to view and run the automations you assigned.

Задачи, связанные с данной
Create an AARI team and assign team roles to members
An AARI manager is a team admin who can create new teams, add members to their team, and assign
new team roles. AARI admin can also configure a team but does not have a team role.
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Assign teams to a process
You can follow this task to assign teams to a process.

1. Navigate to Manage > Processes.
The Process Setup page appears for you manage your process.

2. Select your existing process from the list of available processes.
For example, you select the Ordered Items process.
The Edit process page appears with details of your process.

3. Navigate to the Teams tab.
4. Click the plus (+) icon to assign the teams to your process.
5. Select your team or teams.
6. Click Add & save.
7. You can repeat these steps and add teams to another process of your choice.
8. Щелкните Закрыть.

You have successfully added teams your process.
You can now assign teams to your бот.

Задачи, связанные с данной
Assign an AARI team to a process
An AARI admin can configure processes in the web interface and assign teams to a process for request
creation. They access the web interface to view and manage processes in the Process Setup page.

Assign teams to a бот
You can follow this task to assign teams to a process.

1. Navigate to Manage > Bots.
The Bot Setup page appears for you manage your боты.

2. Click Add bot.
The Add bot page appears for you to add available боты.

3. Select a бот or боты.
For example, you select the Enterprise Account бот.

4. Click Add to add бот.
The бот that you selected will now be added to the бот list.

5. Select the бот that was added.
The Edit bot page appears with details of your бот.

6. Navigate to the Teams tab.
7. Click the plus (+) icon to assign the teams to your bot.
8. Select the team that you have created.
9. Click Add & save.
10. Щелкните Закрыть.

You have now successfully added teams your бот.

Configure iFrame widget in a web application
You must configure iFrame widget settings in a supported web application to properly enable the iFrame
widget.
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Убедитесь, что вы выполнили указанные ниже действия.
• Предоставили созданную системой функцию AAE_Robotic_Interface User пользователю AARI.
• Have access to the AARI web interface.
• Have access to the web application of your choice that supports the iFrame technology. For this task, it

would be the ServiceNow Service Portal and ServiceNow App Engine Studio.

1. Log in to the ServiceNow Service Portal.
2. Navigate to the Widget Editor page.

This page has a few options for you to configure your widget, as well as a reference for you to view
any recently updated widgets.

3. Click the Create a new widget option for creating new widgets.
The Add a Widget window appears with details for you to specify your widget.

4. Specify the name of the widget in the Widget Name field.
The ID of the widget will be automatically generated when you enter the name.
For example, you can name your widget AA Bots for reference that this is an Automation Anywhere
боты widget.

5. Щелкните Отправить.
A new window with an HTML template or editor prompts you to enter the iFrame widget details, if
applicable.

6. Paste your iFrame widget code to the HTML template.
This is the iFrame widget code that you had generated in the AARI web interface.

7. Click Save or press Ctrl + S to save the current session.
You have now added the iFrame widget code and saved your session. This is the code to embed your
iFrame widget.

8. Access to the main page of the ServiceNow App Engine Studio.
9. Navigate to All > Service Portal Configuration
10. Click Designer.
11. Select an existing page to edit.

You are now directed to a designer page.
12. Необязательно: Rearrange or remove your existing widgets on the page, to give space for the iFrame

widget.
13. Drag the widget you had created (ex: AA Bots) from the Widgets tab and place it on the page.

You have now successfully added the iFrame widget and should now be visible on the page.

Важное замечание:  The iFrame widget is visible but with no styling applied.

14. Navigate back to the ServiceNow Service Portal
15. Click Widget Editor.
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16. Click on your widget (ex: AA Bots) from the Recently Updated list.
You are now navigated to the window with an HTML template. The page should also include a CSS
template.

17. Specify the widget (ex: AA Bots) details in the CSS template.
This can be the border size, style, and color of the widget.

18. Navigate back to the designer page.
The iFrame widget structure has now been updated.
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19. Refresh the page.
You will notice a small-sized window that appears and is connected to the AARI web interface with a
login page.

20. Log in with your user credentials to the iFrame widget in order to access your AARI data.
The iFrame widget will refresh and a list of automations and tasks from AARI is now available. You can
interact directly with your data.
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21. View the iFrame widget.

You have now successfully embedded the iFrame widget with AARI data to your web application.
For your next steps, you can deploy your automations using the iFrame widget, see Deploy automations
in web application.

Deploy automations in web application
You can now automate your tasks using the iFrame widget.
Убедитесь, что вы выполнили указанные ниже действия.
• Предоставили созданную системой функцию AAE_Robotic_Interface User пользователю AARI.
• Have access to the AARI web interface.
• Have access to the web application of your choice that supports the iFrame technology. For this task, it

would be the ServiceNow Service Portal.

1. Log in to the ServiceNow Service Portal.
2. Navigate to the page(s) on which you had embedded the iFrame widget.

This can be the Designer portal in the ServiceNow Service Portal where you manage your data and
relevant information.
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3. Log in with your user credentials to the iFrame widget in order to access your AARI automations.
This is the user that is a assigned to a team.
The iFrame widget will refresh with a list of available automations.

4. Необязательно. Fill your initial forms using URL parameters.
You can modify your URL with specific query parameters, to provide more control over your specific
data.

Прим.:  Embedded Automation supports these parameters: Check Box, Date, Dropdown, Number,
Radio Button, Time, Text Area, and Text Box. For more details, see Параметры URL-адреса.
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5. Run your automations or complete pending tasks.
You can deploy automations using the iFrame widget in the ServiceNow Service Portal.

Прим.:  You can run your bots with the Picture-in-Picture feature. You can enable this feature when
you configured your bot in AARI to run in a virtual window. См. раздел Configure an AARI bot.

Ссылки, связанные с данной
Параметры URL-адреса
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Этот раздел поможет вам создать ссылку на параметры URL-адреса для поддерживаемых элементов.

Smart embedded forms and dynamic data mapping
As a developer, you can design smart forms to embed in a widget of a host web application where you can
run a script to populate data dynamically.
This enhanced form builder experience enables you to quickly design smart forms with more concise
controls. The smart forms are embedded as a widget (using iFrame widgets) in a web application where
you can populate data dynamically and run your automations.

See the following video for an overview of smart forms and dynamic data mapping:
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What a developer can do

Design smart forms with the enhanced form
builder:

• Drag form elements directly to the form builder
to add new elements.

• Resize individual form elements to a precise
length.

• Design forms to use in an embedded widget.

Populate data dynamically in an embedded
widget:

• Utilize a Javascript for a host web application to
read and use as inputs in AARI processes.

• Run a script (postMessage API JavaScript) to
populate the data of the AARI process based on
the process ID, element ID, and its value.

Преимущества

Smart embedded forms provides the
following benefits:

• Dragging and resizing form elements are a
seamless and consistent experience.

• Developers can quickly add new elements to
their forms.

• Forms created in the form builder is rendered
the same way in an embedded widget.

• Form builder supports up to 25 form elements.
• Behaviors of the older forms are maintained.

Dynamic data mapping provides the following
benefits:

• Data is populated dynamically to avoid repetitive
data re-entry.

• Only specified data are dynamically populated,
which provides a secure way to run automations.

Понятия, связанные с данным
Embedded Automation
Access automated processes and боты from any platform with an embedded interface. Embedded
Automation delivers automation everywhere you want, either integrated with your web application or
delivered through a browser extension.
Обзор AARI Integrations
You can use a widget that embeds automations built on the Automation 360 platform that can be applied
natively on any supported web application.

Map host data to process
You can configure your widget settings from a host application and populate data in the initial form of
your iFrame widget. This ensures that you have control over your data without the need for repetitive data
entry.
Убедитесь, что вы выполнили указанные ниже действия.
• Предоставили созданную системой функцию AAE_Robotic_Interface User пользователю AARI.
• Have access to the AARI web interface.
• Have access to the host web application of your choice that supports the iFrame technology.
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• You already set up the iFrame widget. For more details, see Configure iFrame widget in a web application.

1. Log in to the host web application.
This is your target application with the iFrame widget.

2. Navigate to widget settings page or source code of your host web application (where you added the
iFrame widget code).
This page contains the embedded code for your widget source.

3. Enter the host data and send data in the script.

Важное замечание:  To map data, you must load a process on the host web application with a
process ID, element ID, and values of the element ID which correlate with each another.

Example structure of host data:

hostData =
{
 process ID
    {
       elementID1: value1
       elementID2: value2
       elementID3: value3
   }
} 
sendDataToEmbeddedApp = (processID) =>
{
    iframeElement = document.querySelector();
    iframeElement.contentWindow.postMessage({data: hostData[processID]}, 
        iframeElement.getAttribute());
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}

Прим.:  The element ID uses form element data types, such as: Check Box, Number, Radio Button,
and Text Box.

An additional sample structure:

In this example: 45 is the process ID, Number0 is the element ID, and 45 is the value of the element
ID.

4. Click Save or press Ctrl + S to save your session.
You have now configured the host data, and mapped the data to your processes.

© 2023 Automation Anywhere. All rights reserved.     2257



    Automation Anywhere - Сборка

5. Перейдите в iFrame widget.
The iFrame widget should show a list of automations.
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6. Click a process to open an intial form with data already mapped and filled in.

The initial form shows the mapped data.
7. Click Submit to run your automations.

Обзор AARI Extensions
Access automations in any web scenario with AARI Extensions, offering a custom widget through Google
Chrome extensions.

Важное замечание:  The OAuth 2 configuration is required, and availability of this feature is based on
your region.
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Benefits and capabilities of AARI Extensions

Broader access to automations brought to
your familiar environment

With AARI Extensions, you can develop custom
actions and workflows. The OAuth 2.0 connection
offers a seamless connection from the Automation
Anywhere Control Room to your web browser.
This connection extends automated features into
your preferred environment through embedded
web components. Develop these components
in any web scenario through the use of AARI
Extensions. Users with these components can
launch automated processes and боты directly from
existing environments, where most time is spent.
With this access, business data can be retrieved
and processed without ever changing applications.

Secure connection with admin control for
organizing team and user workloads

AARI Extensions is fully integrated with Automation
Anywhere for security and authorization of
content. This means that the administrator has
complete control over which content is made
public through AARI by assigning AARI Extensions
content to teams. Content assigned to a team will
become visible to the members of the team when
the target pages are opened. With this control
and organization, administrators can develop
specialized components for specific team functions
by empowering users with streamlined automations.

Requisites:
• OAuth 2 Control Room configuration: Using secure credentials, configure a security token to validate

your identity as a licensed user. Servers will recognize this token and approve your access, eliminating
the need to log in multiple times to your accounts. Use AuthConfig App to enable OAuth2 services

• Automation 360 v.26 or later
• Chrome browser
• AARI licenses: AARI Extensions uses teams and members to securely authorize and deploy content to

the right users.
• AARI fluency: Administrators should be familiar with the environment in order to identify key elements

used to map custom content to teams.

Additional considerations:
• Roles: Ensure that you have the proper role and permissions for your activity. AARI web interface users
• Ensure that your browser is not blocking AARI Extensions access and windows.

Последовательность операций процесса

The end-to-end workflow is illustrated in the following diagram.
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1. To begin accessing features, set up and connect your Control Room to AARI Extensions. Set up and
connect AARI Extensions

2. Develop and embed content in your preferred application for AARI Extensions. Develop a widget for
AARI Extensions

3. Administer your developed content to teams for users to access through AARI Extensions. Provisioning
AARI Extensions to teams

4. Get started using the embedded content through AARI Extensions. Deploy automations in web
application

Set up and connect AARI Extensions
Set up and connect AARI to AARI Extensions.
• Ensure that you meet all the prerequisites. Обзор AARI Extensions

© 2023 Automation Anywhere. All rights reserved.     2261



    Automation Anywhere - Сборка

• Have your Service Account Token accessible to enter in setup. Create a service account for AARI
Extensions

Прим.:  This token is an API key generated in the Control Room, from Settings.

AARI Extensions requires setup and connection of your system. Perform the following steps to complete
the setup illustrated in the following diagram.
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The following video shows the setup process.

1. To open the Extensions setup in a new tab with context about the AAI tenant, in AARI, click Connect
Accounts.

Прим.:  Your Control Room URL and Partner ID will be automatically filled as part of the setup.

2. Select your Google or Microsoft account to begin the process of deploying and connecting AARI
Extensions to your Control Room.

3. Enter a Name for the new AARI Extensions Tenant that will be connected to your Control Room, for
example, Production.

4. In the Control Room settings:
a) Enter the Username of the Service Account that you created previously.
b) Enter the Service Account API Key to use for server-to-server communication.

5. Select Connect.
AARI is now connected to AARI Extensions, and you can assign developed content.
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Develop a widget for AARI Extensions

Create a service account for AARI Extensions
Create the service account and assign permissions to customize the AARI Extensions experience in your
embedded widget.
Use your AARI admin account (AAE_Robotic Interface Admin) to create a new user with the proper
role and permissions to configure the AARI Extensions experience.
Overview
1. Role: Create a new AARI role, with specific permission, to operate in AARI as the service account.

The permission you assign will structure the AARI Extensions experience.
2. User: After you set up the AARI role, create a new user and assign the role to administer permissions.
3. Key: Generate the API-Key of the user account that AARI Extensions will identify as the service

account. During setup of AARI Extensions, enter the API-Key.
4. Connect: Name the account to complete the AARI Extensions connection.

To grant permissions to the role:
1. Log in to your Control Room as an Admin user.
2. Navigate to Administration > Roles in the left-hand menu.
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3. Click Create Role at the top right of the page.
4. Enter the name for your new role and select the following permissions on the Features page.

These permissions enable the AARI Extensions server to query information to verify user access and
save metadata to AARI.
• Просмотреть пользователей
• Просмотреть функции
• Просмотреть основную информацию о пользователях и функциях
• Просмотреть лицензии
• Создать API-ключ
• Extension API for service account

5. Save your new role.
To create a new user for your service account and assign the role:
6. Navigate to Administration > Users in the left-hand menu.
7. Click Create User located at the top right toolbar to define a new service account user.
8. Enter information in the required fields and select the role you previously created and assign it to this

user.
9. Select Allow for Allow Multiple Sessions on the user creation page.
10. Щелкните Сохранить.
To generate the API key:
11. Log in to the Control Room with the user you previously created.
12. Click your user name in the left-hand menu and then click My Settings in the profile card that

displays.
13. Select Generate API key at the top right of the My Settings page.

14. Save the API key to use when connecting AARI Extensions.

Set up and connect AARI Extensions

Develop a widget for AARI Extensions
Develop the iFrame widget in AARI Extensions to deploy in your web application.
• You must be logged in to the Control Room with AAE_Basic permissions.
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• Ensure that AARI Extensions is installed in your browser by completing setup. Set up and connect AARI
Extensions

• Set up the widget in AARI that will map automations into AARI Extensions. Setup iFrame widget using
AARI Integrations

• Have the widget embed code accessible to enter into AARI Extensions. You need only the URL in
quotes after src=.

With AARI Extensions, your Chrome browser will act as the vessel to embed the widget. Using the
following steps, develop an iFrame widget for your web application and deploy the widget to AARI to map
your complete embedded automation experience. While you can develop many web components, the
following steps streamline a simple process to bring automations directly into your web application.
The PixieBrix Page Editor environment is used to map and configure automations from AARI to your
web application and select the component for embedding the widget. This environment uses your OAuth
connection to access saved processes and automations from your Control Room and map them to the
selected component. For complete details on developing in the Editor, see the following link: Guide to
PixieBrix Page Editor
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The following video demonstrates the process of developing the widget in AARI Extensions.
1. To begin, navigate to the web application where the iFrame widget will be embedded.
2. Select the Render Panel action and delete it by clicking the trash icon on the top of the pane.
3. To open the page editor, from the desired web application, right-click and select Inspect.

The following table and image details the development environment.

Panel Описание

1 Extensions List Create and select an extension for development.

2 Extension Overview Add, view, and edit the components of the extension.

3 Configurations panel Map and configure how components interact with the
web page.

4 Data panel Test and debug your extension.

4. From Extensions List, click Add and select Sidebar panel.
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5. From the Overview panel, click the plus icon to open the component menu.
6. Select the iFrame component and click Add brick.
7. In the Configuration panel, complete the necessary fields.

a) Enter the Name of the widget. This name will appear in AARI when you begin provisioning to
users.

b) Enter the widget URL to access your Control Room.

This is the URL taken from the embed code found in AARI Integrations. You need only the URL in
quotes after src=.

8. Save your Extension.
9. Test and debug your extension by using the data panel.

The final output is detailed in the data panel and alerts you to any action that might be mapped or
configured incorrectly.

Важное замечание:  If an alert for invalid connection or invalid credential appears, check that you
have set up and connected AARI correctly to AARI Extensions.

10. After successful verification, click the vertical ellipses in the Extensions List panel to add your
extension to a blueprint.

11. Select create new blueprint.
12. Select move or copy into the new blueprint.
13. Enter your unique id.
14. Enter the name to identify the extension in the next step.
15. Enter the version for developers to identify the progressive customizations made over the life of the

extension.
16. Enter a description.
17. Click Create to save your changes.

After developing the extensions for your team, deploy the blueprint to AARI Extensions. Deploy mod to AARI
Extensions

Deploy mod to AARI Extensions
Select and deploy the version of a verified extension for Teams to access in AARI Extensions.
Select and deploy an extension version (called a mod) for teams to access in AARI Extensions. Mods
package all customizations and return them to the web application as a single version. This provides
developers access to make improvements on one version while users simultaneously run a verified version.
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Use the management console in the AARI Chrome extension to deploy a mod and control the version of
developed artifacts.
AARI Chrome extension offers a management console for development artifacts to provide version control.
Select the version of an extension by choosing a mod from the console. Mods package all customizations
and return them to the web application as a single version. This allows developers access to make
improvements, while users run a verified version.
This task describes how to deploy a mod from the AARI Extensions management console to populate your
widget and make it accessible.
Prerequisites
• Use a Google Chrome browser with a profile setup with AARI Extensions.
• Ensure you have access to two AARI users, one with the AARI admin profile for set up and one with the

AARI user profile for testing.

1. You can either:
• Open a new browser window on your machine and log in to AARI Extensions as an AARI

Administrator user; or
• Open a new browser window on a different machine to easier manage active sessions.

Совет:  Use Chrome Profiles to manage multiple user profiles on the same machine. For each user
profile created, the user must log into AARI and install the Chrome extension into that Chrome profile.
Then, each user must log in to the Chrome extension using their respective AARI credentials. This
management method:
• Organizes profiles for Administrator, Developer, and end users for testing.
• Optimizes managing multiple sessions when tasks are completed on the same device.

To learn more about Chrome Profiles, see Google Chrome help

2. Open the Console page by selecting Chrome > Extensions > PixieBrix.
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3. Click the Options button in the slide out panel that appears.

4. If prompted to log in enter your Control Room URL and log in using the AARI Administrator user
account.

Прим.:  To switch to a different user in the existing session, click Open Admin Console at the top
right of the page. In the new tab, click the username and select Logout.

5. When logged in as the AARI Administrator user, click Open Admin Console at the top right of the
page.
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6. Select Deployments from the left navigation menu.

7. Click + Create Deployment at the top right of the Deployments page.
8. Enter the name of your deployment.
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9. Select the mod of the extension you previously created using the Develop an widget for AARI
Extensions procedure. Develop a widget for AARI Extensions

10. Click Create Deployment to save your settings to AARI.
11. In a new tab or window, navigate to Automation Anywhere AARI and log in as an AARI Administrator

user.
12. Open the Extensions page by selecting Manage > Extensions from the left-hand navigation menu.
13. Click + Add Extension on the top right of the page.

Your newly deployed extension displays in the table.
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14. Select the check box next to your deployed extension and then click Add & Save.

You return to the Extension Setup page.
15. From the Extension Setup page, select the deployment you added.

AARI navigates to the Properties page.
16. To assign one or more teams, select the Teams tab at the top of the page.
17. Click the + button on the bottom right to open the Teams dialog.

18. Select the Teams for which to assign the extension.
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19. Click Add & Save to activate and deploy an AARI Teams customization.

Test the customization.

Прим.:  If using Chrome Profiles, switch to a user profile dedicated to an AARI user profile that belongs to
this respective Team. Otherwise, follow the steps to log the user out of the Chrome extension and then log
in with a user that already has an AARI user license assigned and has been added to this respective Team.

As the user, navigate to your configured application, (similar to how Workday was configured in the
previous task). After you access the page configured on the Trigger, the Sidebar panel should automatically
display with the list of available automations for the user.

Provisioning AARI Extensions to teams
Organize and assign developed extensions to teams for business roles and functions.
Ensure that you have completed development of the AARI Extensions content. Develop a widget for AARI
Extensions

After developing an extension, make sure to refresh AARI to load recently developed content.
1. In AARI Extensions, click Add Extension.
2. Select the extension.

Recognize the extension by the Name you entered in development.
3. Click Add and Save
4. To edit properties, select the newly added extension on the Extension Setup page .
5. Click the Teams tab.
6. Select Teams to assign them the extension.
7. To commit your changes, click Add and Save.

The ellipsis on the far right of each team offers an option to send the extension link to users.
Users will now be able to access the widget from their web applications.

Check out what users can do with the extension. Deploy automations in web application

Embedded Automation example using AARI Integrations
An Embedded Automation widget is invoked as an Interaction Widget inside Genesys Cloud. The agent
uses the widget to correct a pricing error without leaving Genesys.
Embedded Automation
Business users can directly access authorized automation from within their favorite business applications,
without having to open a new interface or learn a new app. Embedded Automation delivers automation
everywhere you want, through a widget, either integrated with your web application or delivered through
a browser extension. To make the widget accessible, create and configure the widget in your preferred
application. Then populate the widget by assigning pre-built automations to teams in AARI. Those teams
can access Embedded Automation to complete daily tasks.
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Setup
1. Complete the setup process flow Обзор AARI Integrations

2. Assign automations Assign automations to teams

3. Automations assigned should include the following.
• Attended бот (that can be deployed on the local device) Attended and unattended automation
• AARI Process invocation (with two human step forms) Развернуть процессы
• Unattended бот (triggered via AARI process with no human inputs) Создание процесса AARI

Совет:  Usable sample code
You can download the following sample code to test this example in your own environment. GitHub:
Embedded Use Case 1

Example Summary
In this example, a contact center agent receives a call about an order with an incorrect charge. The agent,
operating in Genesys, responds using the embedded widget by launching automated processes and боты,
and handles the order correction without leaving Genesys. Deployed automations touch Salesforce and
Zoho Sales Order Management to correct the error in respective systems. Assigned automations are
detailed in the following image.
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This example describes steps the agent takes to correct a pricing error while in Genesys, by using the
Embedded Automation widget.
1. Deploy the Salesforce Account Lookup бот and enter the phone number to pull up the account

record.

Copy the SFDC Order Number to enter in the next step.
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2. Launch the Order Items Price Correction process from within the widget and enter the order
number you have retrieved.
A Бот retrieves order details from Zoho and renders the Display Order Details in a form, including
products and prices paid.
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3. Correct the price on the item in question.

4. Optionally, select the 3% discount for courtesy.
5. Щелкните Отправить.

The бот calculates the amount to be reimbursed.
6. The бот creates a billing update for refund in Zoho.
7. A reference number is generated, and the system indicates it will take 5-7 business days for refund to

appear on card.

After the case is resolved, upload case notes from all cases handled through the day into a compliance
application for audit.
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Enter the file location, for the automation to sends notes to the appropriate contacts.

Embedded Automation example using AARI Extensions
Embedded Automation provides automation everywhere you want through a widget, either integrated with
your web application or delivered through a browser extension. You can use an embedded widget inside
Workday. For example, an Human Resource admin enters an employee address and can order business
assets to ship without leaving Workday.
Embedded Automation
Business users can directly access authorized automation from within their favorite business applications
without having to open a new interface, or learn a new app. You can invoke the widget in Workday. To
make the widget accessible:
1. Create and configure the widget in your preferred application.
2. Assign any pre-built automations in AARI required for teams to complete their daily tasks.

The widget (shown in the following image) populates assigned automations for specific roles.

Setup

© 2023 Automation Anywhere. All rights reserved.     2280



    Automation Anywhere - Сборка

1. Complete the following setup process.
a. Set up and connect AARI Extensions

b. Setup iFrame widget using AARI Integrations

c. Develop a widget for AARI Extensions

Прим.:  For this example, configure the widget to trigger as a Page Load event.

d. Provisioning AARI Extensions to teams

2. Two types of automations are assigned in this example and include the following details:
• Attended бот (that you can deploy on the local device). См. раздел Attended and unattended

automation.
• AARI Process invocation (with two human step forms). См. Развернуть процессы

Совет:  Sample code
You can download sample code to test this example in your own environment. See GitHub: Embedded Use
Case 2

Example Summary
An HR Admin logs into the Workday application and views the new widget sidebar on the home page that
has been deployed by the RPA Center of Excellence (CoE). The sidebar opens has been designed to open
automatically when the user accesses the Workday application and the page has completed loading.
The HR Admin can use Embedded Automation to access and update an employee address, and then order
hardware assets to deliver to that employee.
The deployed automations used in this example touch Workday and Zoho Sales Order Management (used
to complete the transaction):
• An attended бот (Employee Work Address Update) built for an HR Admin to quickly locate and

update home office address details of employees, using interactive forms and local desktop automation.
• An AARI process invocation (Device Order for Employee) built for an HR Admin to order hardware

assets (such as laptops and keyboards) for employees directly in Workday.
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1. Start the Employee Work Address Update automation used to enter the Employee ID of the
person you want to update.
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2. Enter the Employee ID to search Workday for the employee.

3. Enter the employee's address details using the provided form to update the employee data.
This example shows a simple address update. However, you can update other employee details based
on the available APIs in your Workday instance, or by using the Automation Anywhere Universal
Recorder.
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4. Click Save Changes.

The automation updates the employee data in Workday.
The second automation (Device Order for Employee) simplifies daily tasks of the HR Admin. This adds
an automated process for device ordering that is embedded directly in the Workday application using the
same sidebar. Typically, this task would require navigating procurement applications to locate and order
devices, and while navigating the Workday application to capture shipping address details of the employee.
By bringing the ordering process into the primary application where daily tasks are performed, the task is
simplified. Similar to the previous task, when the HR admin logs into Workday, the sidebar appears with
the list of available automations their CoE has deployed.
5. Locate the New Device Order for Employee automation displayed in the sidebar and click Start.

A new instance is created.
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6. Enter the Employee ID for a new order.

After submitting a valid Employee ID, the automation locates and returns the employee details within
Workday.
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7. Confirm the employee details and select the hardware items to order.
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8. After the automation has created a new order in the company's order management system (Zoho
Order Management), the automation returns the Sales Order number (SO-00012) for reference.

Embedded Automation example using AARI Extensions and AARI
Integrations
Embedded Automation provides automation everywhere you want through a widget, either integrated with
your web application or delivered through a browser extension. Have an employee submit an order request
and a manager approve the request.

Embedded Automation

Business users can directly access authorized automations from their favorite business applications without
having to open a new interface, or learn a new app. You can invoke the Embedded Automation widget as a
widget in ServiceNow or as a sidebar in SAP. To make the widget accessible:
1. Create and configure the widget in your preferred application.
2. Assign any pre-built automations in AARI required for teams to complete their daily tasks.

The widget populates assigned automations for specific roles.
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Example Summary

A company employee (Jane) submits a request to order replacement hardware. Jane (operating in
ServiceNow) uses the embedded widget to launch an automated бот to process the order, and submit
for approval to a Cost Center Manager (Gerald). Gerald (operating in SAP) uses the embedded widget to
launch automations that approve and complete the hardware shipment order.
The widget is visible in ServiceNow as a custom ServiceNow component that is placed into the Employee
Service Portal page. The widget is invoked as a sidebar through the web browser. For users operating in
SAP S/4HANA, the sidebar appears on a page load trigger.
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Настройка

1. Complete the setup process flow for ServiceNow. См. раздел Обзор AARI Integrations.
2. Complete the setup process flow for SAP. Обзор AARI Extensions.
3. Assign automations. См. раздел Assign automations to teams.
4. The embedded widget can contain combinations of three types of automations:

• AARI Process invocation (with two human step forms). См. раздел Развернуть процессы.
• Attended бот (that can be deployed on the local device). См. раздел Attended and unattended

automation.
• Unattended бот (triggered through AARI process without human input). См. раздел Создание

процесса AARI.

© 2023 Automation Anywhere. All rights reserved.     2291



    Automation Anywhere - Сборка

Совет:  Sample code
You can download the following sample code to test this example in your own environment. See GitHub:
ServiceNow.

Procedure

This embedded widget example includes the AARI Process automation type.
The Hardware Replacement Request AARI process allows an employee access to the business
ServiceNow Service Portal for IT requests. An employee can use the embedded widget to automate
requests. Jane's order request includes replacement hardware such as: keyboards, mice, or laptops.
When Jane opens ServiceNow, they can see the automated process for Hardware Replacement
Request within the widget.

1. Jane initiates the Hardware Replacement Request and is taken to an input page in the widget
where they enters the information required to execute the automation.
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2. Jane can select the request for self, or as another employee, and click Submit.
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3. After submitting her request, the next automation connects Jane to the business HR system where
Jane gathers employee details, such as shipping address. The system connects to the procurement
system to to retrieve the available items to order.

Прим.:  This example includes these steps in the automation to reduce reliance on additional
systems.
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4. This business rule was created in this automation example to check the total order value:
If the total order value exceeds the company threshold of $3000, then an approval is required from
the cost center owner. This generates a request to Gerald.

5. Gerald focuses on different tasks in the cost management application (SAP). The list of automations
in the sidebar is focused on orders, inventory, and other sales related processes. When the widget
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generates Jane's request for Gerald, a toast message displays in the inbox for the new task in the
widget.

Gerald selects My Tasks to view the request and continue with the AARI approval process.
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6. Gerald approves the request and adds any comments, remaining in the SAP environment.
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7. Jane can see the details and status of each step in the overall process in the workspace widget. She
can see that all successful steps have completed, and an IT ticket has been created and closed to
track the request.

Getting started with Обнаружение процессов
Обнаружение процессов enables organizations to accelerate the automation of business processes and
discover the fastest path to process optimization and business ROI (return on investment). You can use
Обнаружение процессов in various industries such as: healthcare, life sciences, and finance.

What is Process Discovery

Обнаружение процессов is the first step in automation used to identify which processes can be
automated in a business. Обнаружение процессов uncovers business processes by capturing user
interactions with various systems and analyzing the interactions to identify patterns. You can capture and
analyze user interactions with any of these systems:
• Enterprise solutions: ERP (enterprise resource planning), CRM (customer relationship management),

BPM (business process management), and ECM (enterprise content management)
• Personal productivity applications: Microsoft Excel and Outlook
• Terminal and virtual environments: Citrix XenApp and Remote Desktop
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Why use Обнаружение процессов

Many companies begin their automation projects with manual observation and documentation. Manual
production and review of process documentation requires interviewing business users and mapping work
flows while they are performing daily operations. This involves additional resources which can be time-
consuming for all involved. This additional effort is also subject to inaccuracies due to users behaving
differently while being monitored. As a result, many of the automation opportunities remain undiscovered.
Обнаружение процессов uses visualization tools to view process details and metadata, and review
identical processes that differ across regions, teams, or apps.

Scalable optimization capabilities

You can use Обнаружение процессов to identify the processes in your business that you can automate.
Обнаружение процессов helps you:
• Capture, parse, and analyze user interactions with various systems.
• Identify and map all relevant pathways (including variations) and automatically documents the most

common workflow.
• Compare the potential ROI from automating these processes and enables Business Analysts to

accelerate automation and maximize RPA ROI.
• Convert automation opportunities into бот prototypes using the Process Definition Document (PDD) for

further development and deployment by the Automation Developer.

Process Discovery end-to-end workflow

The following diagram shows the Обнаружение процессов end-to-end workflow for Admin, IT, and power
users:
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1. Set up users and assign Обнаружение процессов roles.
2. Install Privacy Enhanced Gateway (PEG) in the On-premises Cloud to limit Personally Identifiable

Information (PII) and sensitive data capture.
3. Install Neo Sensor on multiple end-users (Observer's) machines for simultaneous process capture.
4. Verify and configure Observer data capture to ensure you only capture what you want.
5. Create cycles for event data based on groups of observers, applications used, or time frame.
6. Classify application screens and create web applications for mining.
7. Review events and filter data to identify key mining parameters.
8. Create mining runs to discover patterns and prepare for automations.
9. Map and compare workflows in data visualization tools. Prioritize processes based on ROI and select a

process for automation opportunities.
10. Select and annotate instances and create a Process Definition Document (PDD) for bot developers,

compliance, training, or process improvement.
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Process Discovery users
Learn about the various users in the Обнаружение процессов platform and their privileges from creating
mining runs and exploring processes, to creating web applications and creating a Process Definition
Document (PDD).
The Обнаружение процессов platform includes the following user types:

Administrator Creates users in the Обнаружение процессов
platform and has administrative permissions to
manage the tenant, cycles, users, observers, and
integrations.

Power user Creates mining runs, explore processes,
classifies application signatures, and creates
web applications. The power user does not have
administrator privileges.

Discovery user Creates mining runs and processes, and can review
events.

Limited user Can access only the Client Dashboard and assets
attached by a higher permission user.

Data Review user Selects and reviews data for all observers in the
Обнаружение процессов platform. The data
reviewer user has access only to the Review tab
and Data Review page.

Create Обнаружение процессов users and assign roles
As an Administrator user, you can create users and assign roles in the Обнаружение процессов platform.
1. Log in to your Обнаружение процессов platform as an administrator.
2. Click your account initials in the upper-right corner and select Manage Users.
3. Click Create User.

The Create New User window appears.
4. Enter the first name of the user in the FIRST NAME field.
5. Enter the last name of the user in the LAST NAME field.
6. Enter the email address of the user in the EMAIL field.

This is also the unique user ID for the user.
7. In the ROLE field, click the drop-down to select a Обнаружение процессов role for the user.
8. To select an avatar for the user, click Choose Image file.
9. Navigate to an image on your computer and click Open to select the image.
10. Click Create User.

Обнаружение процессов automatically generates and sends an email inviting the user to log in and
use the platform.

Прим.:  If the user does not activate the account within 24 hours of receiving the email invitation,
click the Didn't receive confirmation instructions link on the login page to resend the
confirmation email. Enter the email address in the field provided and click resend confirmation
instructions.

© 2023 Automation Anywhere. All rights reserved.     2302



    Automation Anywhere - Сборка

11. To reset a user password for a fully registered user, click Actions > Force Password Reset.
12. Click Yes to reset the user password.

A message appears notifying you that the user will have to change their password on the next login
attempt.

Create your event reporting password
As an Administrator user, you can create your own password for the Event Reporting interface.
The Event Reporting interface uses Kibana which provides you reports about how people interact with
applications and screens. Using the reports, you can determine where to focus your process discovery.
1. To create your Event reporting password, log in to your Process Discovery platform tenant.
2. Click your account initials in the upper-right corner and select Manage Users
3. Locate your account details in the users list.

Совет:  To quickly locate your account, click Filter. Enter your email address, select a role, and click
Apply.

4. In the Actions column, click the drop-down arrow and select Set Event Reporting Password.
The Set Event Reporting Password window displays.

5. Enter your password and click Set Password.
The password is ready to use the next time you log in.

Create a URL and application list
Learn how to create a domain list (containing the URL) and application list for data that you want to
capture or exclude on an Observers machine.
This task is performed by an Administrator. Before you configure Observer activity for data collection, you
create domain list and application list.
To create a domain list, perform the following steps:
1. Log in to your Обнаружение процессов platform as an administrator.
2. Click your account initials in the upper-right corner and select Domain List.
3. Click Create List.
4. In the Name field, enter a name for the list.

For example, enter Business applications.
5. In the Type field, select Allow to capture URLs or Block to exclude the URLs.

Прим.:  The blocked URLs will not be displayed in the screen shots from the Events page.

6. In the Domain field, enter the full URL address.
For example, enter www.servicenow.com, www.sap.com, or www.oraclefinancials.com.

Прим.:  When specifying domains, you must explicitly indicate what domains to include or exclude.
For example, if chase.com is blocked, the secure05c.chase.com would not be blocked. You must
include secure05c.chase.com on the list.

7. Click Add to add the specified domain to the list.
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8. Click Create List.
You can now select this Block or Allow URL list from the Observers page for data you want to capture
or exclude, for an individual observer or group observers, based on your requirements.

To create an application list, perform the following steps:
1. Click your account initials in the upper-right corner and select Application List.
2. Log in to your Обнаружение процессов platform as an administrator.
3. Click Create List.
4. In the Name field, enter a name for the list.

For example, enter Business applications.
5. In the Type field, select Allow or Block from the drop-down.
6. In the Application field, select an application from the drop-down or enter an application in the text

field.
7. Click Add to add the application to the list.
8. Click Create List.

You can now select this Block or Allow Application list from the Observers page for data you want to
capture or exclude, for an individual observer or group observers, based on your requirements.

Прим.:  To create a default Block and Allow URL or Application list for all new observers in a tenant,
click your account initials in the upper-right corner and select Manage Account. In the Observer
Settings section, update the URL or Application Block and Allow List.

Configure Observer activity
As an administrator, you can configure an individual Observer or a group of Observers to capture or
exclude specific sets of data from collection on an Observers machine. This topic describes how to enable
or disable the capture settings (screenshots, keystrokes, title, and keyboard) and apply this to specific
applications.
After the Neo Sensor is installed on the Observers machine, ensure that you:
• Enabled the sensor recording. For more information on enabling or disabling the recording, refer to

Enable and disable the users recording.
• Created your domain and application list before you configure Observer activity.

Прим.:  To enable or disable the recordings for new observers in a tenant, click your account initials
in the upper-right corner and select Manage Account. In the New Observer Recording section, select
Enable or Disable to set the recording configuration for all new observers. Чтобы сохранить изменения,
щелкните Сохранить.

To configure an individual observer or group configure observers for data collection with capture settings,
perform the following steps:
1. Log in to your Обнаружение процессов platform as an administrator.
2. Navigate to Data > Observers.
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3. To configure all observers, select Configure <number> Observers.
This configuration is for all observers using the current filter. You can create filters for specific
departments in your organization (for example, HR or Finance) to filter data collection for a subset of
Observers. Click Filters to create filters.

4. To configure an individual observer, navigate to the Actions column for the Observer and select
Configure from the drop-down arrow.

5. In the Capture section, use the individual toggles to capture or exclude screenshots, keystrokes, title,
or clipboard globally for all applications.

6. In the URL Block and Allow List section, select one of the these options:
Вариант Действие

Нет No action to select. All URLs are captured by the
Neo Sensor.

Разрешить Select the Allow URL list you created from the
Domain List page from the drop-down field.

Block Select the Block URL list you created from the
Domain List page from the drop-down field.

7. In the Application Block and Allow List section, select one of the these options:
Вариант Действие

Нет No action to select. All URLs are captured by the
Neo Sensor.

Разрешить Select the Allow Application list you created from
the Application List page from the drop-down
field.

Block Select the Block URL list you created from the
Application List page from the drop-down field.

8. In the Configure Applications window, enter specific applications in the text field you want to
capture and click Add.
Based on your business needs and the applications you set to capture or exclude, you might need to
capture Screenshots and Titles for data processing of screen signatures.
The application is listed in the Application Name column.

9. To disable capture settings for the application, select the icon for Screenshots, Keystrokes, or Titles.
An X mark appears on the icon.

10. To configure observers by a single user, or group of observers with the same user name, select Use
configuration for observers owned by this user (<user name>).
This option is available for an individual observer only.

Прим.:  When you use this option, the allow and block list that is created for new observers is used
for users with the same user name.

11. Click Configure.
The capture settings are now set for Observers.

12. To enable the capture settings for all observers by default, click your account initials in the upper-right
corner and select Manage Account.

13. In the Observer Settings section, perform steps 5 through 7.
14. Чтобы сохранить изменения, щелкните Сохранить.
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Create a cycle
Learn how to create a cycle for each data collection and add permitted users to the cycle so they can
access the associated events for data analysis. Cycles are defined as a collection of events based on a set
of Observers during a given time range.
Administrators have access to all event data, and can define which Permitted Users (Data Review,
Discovery, or Power user roles) can access the cycle data throughout the Обнаружение процессов
platform. The Administrator informs users when the cycle is ready for them to review. Power users and
all other non-admin users do not have access to create their own cycles and cannot review data until the
Administrator creates the cycle for them. Creating a cycle for Power and all other non-admin users allows
the users to access the data to review events and mine for processes.
To create a cycle, perform the following steps:
1. Log in to your Обнаружение процессов platform as an administrator.
2. Navigate to Data > Cycle.
3. Click New Cycle.
4. In the CYCLE NAME field, enter a name for the cycle.

Пример. Cycle 1: Order Entry and Processing.
5. In the PERMITTED USERS field, select the users that you want to give access to.

Permitted users include only the Data Review, Discovery, or Power user roles. You do not need to add
Admins as permitted users because Admins can access all event data.

6. In the OBSERVED AT field, select the time data range from the Start date to the End date for the set
of Observers.

7. In the OBSERVERS section, you can multi-select Observers or Observer Users from the drop-
down lists. Alternatively, you can select a tag from the Observer tag drop-down list to populate the
Observers.
You can create Observer tags from the Observers page and can use them to identify a team for a
cycle. For example, the team is payroll or recruiting in HR where you can select as many Observers as
required. In a VDI environment, we recommend that you select Observers from the OBSERVER USER
section. This option enables you to easily select from hundreds of Observers and customize based on
the cycle you want to create.

8. (Optional) APPLICATION NAMES, click the drop-down list to select applications.
9. (Optional) In the START SIGNATURES, click the drop-down list to select a start signature.
10. (Optional) In the END SIGNATURES, click the drop-down list to select an end signature.
11. (Optional) In NOTES, enter any notes you want to share with the permitted users.
12. Click Create Cycle.

Classify application screens and create web applications
You can review unclaimed browser events such as Google Chrome, Internet Explorer, and so on, to assign
them to a specific web application.
When using web applications from the Обнаружение процессов platform, the browser name is captured
but the web application or software as a service (SaaS) is not. Web application events (where the
application name is not captured) are stored in the Unclaimed Browser Events section of the Web
Applications page. To classify web application events that are related to the task or process, you must
create specific web applications for the events to be claimed in the application. From the Web Applications
page, you can:
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• Review events in the Unclaimed Browser Events section to locate and filter related process events from
their native browser applications. Typically, Google Search, personal searches, or web mail events are
not relevant to a task or process.

• Create specific web applications that are used in the task or overall process flow, for example: Amazon
Web Services, Slack, Zendesk, and so on.

To review events in the Unclaimed Browser Events section and create web applications, perform the
following steps:
1. Log in to your Обнаружение процессов platform as a power user.
2. Navigate to Data > Web Applications.

In the Existing Rules section, you will see previously created web applications. In the Unclaimed
Browser Events column, you will see various browser application events.

3. In the Unclaimed Browser Events column, click:
• Grouped by: Title to organize the browser events listed in the column by Title.
• Grouped by: URL to organize the events by URL.

4. To filter events in the column, use the data range option under the Unclaimed Browser Events header.
Select the start date (Month/Date/Year) and end date (Month/Date/Year). The events column will
update and display your results.
To filter events by specific event tiles, use the search icon. Enter the title in the search field. The
events column will update to display your results.

5. To view a browser event, click the link to view the set of events from the Events page.
The browser events with the highest frequency titles or URLs are displayed at the top of the column.
These are the most important events for processes that users are recording.

6. From the Events page, verify what web application the events belongs to.

Совет:  We recommend that you note the web titles or URLs as you review the events because you
will create a web rule pattern (regular expression or regex) for each of the targeted web applications.
Additionally, you can use the Filter option to locate specific web applications by Observer Name (for
example) and click through the events in their workflow. Based on your situation, you might filter on
URLs because URLs are unique, whereas titles are not necessarily unique. For example, if you have
two applications with HOME as the title, you should use a URL web based rule instead of the title.

7. From the Unclaimed Browser Events column, continue to review the set of browser events from the
Events page and determine if the events need to be claimed as web application events.

8. After you have located the titles or URL that you need to create web applications, navigate back to the
Web Applications page.

9. Click Create Web Application.
10. In the APPLICATION NAME field, enter the name of the application.

For example, enter Google Search ICD 10 Lookup.
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11. In the APPLIED RULE TYPE section, select the rule type (Title or URL) to use.
For example, select Title.

12. In the RULE PATTERN (REGEX) section, enter a pattern that matches the title or URL of your target
application in the text box.
For example, enter icd10 lookup in the text box. We recommend that you remove "Google Search"
from the application name because there may be similar events (icd10 lookup) in other browsers that
you can also include in the rule pattern.
You can also click the copy icon to copy the title of the web application and paste into the text box.

For example, you only need the title, KTBSonline and there are two KTBSonline titles listed in the
browser events column. The two titles are:
• Verify Login Information | KTBSonline - Google Chrome
• Enroll in Open Enrollment Benefits | KTBSonline - Google Chrome

To capture the events from both titles, you can enter the rule pattern as: Verify Login Information \|
KTBSonline - Google Chrome|Enroll in Open Enrollment Benefits \| KTBSonline - Google Chrome, or
you can just enter KTBSonline and keep the rule pattern simple.
Continuing with the example for KTBSonline, the backslash (\) character precedes the vertical (|)
character to indicate that this is not an OR function in the rule.
To include more than one title in the rule pattern, use the vertical bar (|) character to indicate the OR
function. For example, to include results for PDFfiller OR pdfFiller, enter the rule pattern as: PDFfiller|
pdfFiller.
The caret (^) character is another commonly used character for creating web rules. Use the caret
character at the beginning of the rule pattern when you want to match the exact event title at
beginning of the text. For example, you want events only where KTBSonline is at the beginning of the
text in the application. In the text box, enter the rule pattern as: ^KTBSonline.

13. Click Create.
The system takes a few minutes to create the web application. To verify that the rule is updated, click
the magnifying glass icon in the Actions column. After the web application has completed, a pop-up
notification appears in the bottom left corner.

Review Events and filter data
You can review and filter Events collected from the Observers machine to develop mining insights.
We recommend that you collect Observer events for at least two to five weeks to ensure that all processes
assigned to Observers are completed before data analysis. After a few weeks of collecting Events, you can
review the Events. From the Events pages, power users can:
• Review events to ensure that data is collected from Observers.
• Use the Filter option to sort and display events by single or multiple Observers, application, Observed

at (date range), and so on.
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• Enlarge individual screens to view Observer events (mouse clicks and keystrokes) in detail.

To review and filter Events, perform the following steps:
1. Log in to your Обнаружение процессов platform as a power user.
2. Navigate to Data > Events.
3. In the upper left side, click the drop-down to select an Observer.

By default, all Observers events are displayed on the Events page.
The events collected by the Observer are displayed in the Events table. The total number of Events
collected by the Observer is displayed in the Events text box above the table.

4. Click through the event IDs to view the date range (Observed At), Application, Title, and Field
columns.
Click the gear icon to select additional data to view. The selected data displays a green checkmark. For
example, you can select Screen signatures, Application, Field, and so on. The data displays in another
column within the Events table.

Прим.:  In the Events table, the Observed At date and time range is the time that a user is looking
at the events in the application. The Observed At date range is not related to the Observers location.
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For example, if the Observer is in India and the user is looking at the events in the application in
California, the Observed At date and time is in California time.

For each Event ID, the associated Event screen appears to the right. The following image and table
describe the metadata (1-4) details associated with the screen and the icons (5 and 6) used to enlarge
the image.

Metadata Описание

1 Event ID The ID number associated with the event.

2 Observed At The exact date (Month/Day/Year) and recording time
of the event captured by the Observer.
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Metadata Описание

3 Signature The application screen associated with that event.
Each application has a unique ID.

4 Screen Signature A unique label pattern applied to an application screen
to enable process mining.

Прим.:  Although, Screen signatures are partially
automatic, modifications are required for data mining.
As long as the Screen Signature is logical, multiple
Events may share the same Screen Signature. It is
important that Screen Signatures describe the screen
appropriately because they enable further process
mining.

When you are ready to modify your Screen Signatures
work, we recommend that you work with a
Обнаружение процессов Business Analyst.

5 Image Viewer icon Enlarges the image to full screen mode.

6 Ползунок Expands the width of the image.

5. Click Filter to customize the events you want to view.
Filtering events allows you to better understand the individual steps as part of the overall process you
might optimize. For example, you might refer to the Field column for potential start and end tasks of
process.

6. To filter events for a cycle, select a cycle from the Cycles drop-down and Click Apply.
The Events table is updated and updates events for that cycle.

7. To filter events using a set of rules with conditions (AND, OR) or create a group (combination of
rules), select from the following options or a combination of options:
Вариант Действие

Add Rule A Rule is single condition. Use this to add additional conditions, such as AND, OR. Refer
to the AND,OR examples for more information.

И Filter events only which satisfy BOTH conditions will be included.

For example, the AND operator is
selected and you select Application
Name = Acrobat and Application

Type = web. The filer rules include
events from both Acrobat and web.
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Вариант Действие

ИЛИ Filter events only which satisfy
EITHER condition will be included.
For example, the OR operator is

selected and you select Application
Name = Chrome and Application

Type = windows. The filter
rules will include only events

EITHER in Chrome or in windows.

Добавить
группу

Use this to filter for a combination of rules. A Group can also be a collection of Groups,
or a mix of both.

For example, there is a combination
of Groups, each with their own
group of Rules, collected by an
OR operator. The filter rules will
include events that are either
(on machine AAIComputer_7

AND in Chrome) OR (on machine
AAIComputer_4 AND in Excel).
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Вариант Действие

Operators Select from one of the following operators:

Вариант Результат

= The condition is equal to the input. Пример. Application
Name=Google. This filter rule will include events where the
application is Google only.

>, < The condition is greater than, or less than those in the input.
Пример. ID > 1000. This filter rule will include events where
the ID is greater than 1000.

Прим.:  This applies only for Observed At and ID conditions.
The Observed At filter is the quantity of any event that is
recorded in that exact time.

>=, <= The condition is greater than or equal to, or less than or
equal to those in the input.

Прим.:  This applies only for Observed At and ID conditions.

Прим.:  The examples provided include some of the more commonly used operators.
The full list of operators include:
• В
• !=
• Not In
• Is Null
• Is Not Null
• Matches

8. Click Apply to apply your filter settings and view events.

Select and annotate instances
Before you create groups for the process and generate the Process Definition Document (PDD), you can
select and annotate instances.
• Before you create a PDD, you create a mining run from the Mining Runs page. (Alternatively, you can

also create a PDD from a set of events from the Events page using the Import to Graph option.)
• From the Process Explorer page, review the various paths taken by the observers, where the thickest

path is the most frequent path taken.
• Identify the path you want to view from an event-level.
• Click the View in Instances Viewer icon to navigate to the Instances Viewer page where you can

select and annotate events to include in a PDD. You can also select a process to annotate directly from
the Instances Viewer page.

1. Log in to your Обнаружение процессов platform as a power or discovery user.
2. Navigate to Data > Instances Viewer.
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3. In the upper-left side next to View Instances, click the drop-down to select a process to visualize.

4. After the process displays on the page, click the drop-down to select the instance to include in the
PDD.

5. Click the gear icon to add the Include in Process column.
The Include in Process column provides you a check box for each line order (refer to the Order
column) used to specify which steps to include in the PDD.

6. Click Annotate to update field labels for the selected steps. For all steps that you want to include in
the PDD, leave the box checked and update the action and label from the screen on the right.
Two fields will appear above the screen image.

7. From the drop-down, select a Control Type.
The Control Type refers to the selection performed in the application.

8. In the text field, enter a control label description for the Control Type and click Update.
We recommend that you enter a label description that corresponds with the label in the screenshot so
that when users review the PDD, the output makes sense to them.
For example, select Button from the Control Type drop-down and enter Click New Ticket in the
description field.
The Ann column will display user and the Field column will display the description entered in the text
field.

9. Repeat steps 6 through 8 for all steps that you want to annotate.
The Save Instance to Process button is enabled for all checked items that include both a label and
description. You must annotate all instances you want included in the process for the Save Instance
to Process button to appear.

10. Click Save Instance to Process.
The View Process Details button appears.

11. Click View Process Details to name the process.

© 2023 Automation Anywhere. All rights reserved.     2314



    Automation Anywhere - Сборка

12. In the Name field, enter a name for the process using this suggested format: 5577-21245E Instance
1 for <Mining Run><Process><Path><Instance>.

13. Click Save Process to save the process with a name.
A message appears at the bottom left side notifying you that the process is saved successfully. Click
the hyperlink to return to the Process Explorer page. You can now create groups for the events and
generate a PDD.

Creating groups for the process and generate a PDD
Learn how to create different groups with start and stop events, and use the groups to design a Process
Definition Document (PDD).
After you selected your instances, you can create groups for the events and build your PDD.
1. Click Create Group to place the steps in different groups for the PDD.

You can create groups for tasks that are part of the process.
2. In the Create Group window, drag a step from the process workflow and move it into the Start

Node.
The Start Node is the beginning of the task. For help building the group of steps as tasks in the overall
process, refer to the View Instances page for the selected screens. For example, to create tasks
related to completing fields on a checkout page, you can
• Group all steps in one group and name the group Checkout; or
• Create multiple groups for individual tasks like Add Payment in one group or add Shipping address

in another group.

3. Select the last step in the group and place the screen in the End Node(s).
The End Node(s) is the end of the task.

4. Enter a name in the Group Name text box.
5. Select a color for the group from the drop-down next to the Group Name text box.
6. Click Save to save the group.
7. Repeat steps 2 through 6 for all steps you want to group.
8. Open a new browser tab and navigate to the Обнаружение процессов platform.
9. From the left pane, navigate to Models > Diagram Composer.

In the Browser Processes and Groups section, the instances and groups are displayed.
10. Click the + sign to add a flow box for each group.

Each flow box appears on top of the previous box. Move these boxes into a row or column. The
groups are listed in reverse order from when they were created.

11. To connect one flow box to another flow box, click the > on the side of the flow box and drag the
arrow to connect the boxes.

12. To document a process with branches, click the Decision Point.
A diamond share flow box appears in the composer.

13. In the Details window, click the pencil symbol to enter a name for the decision point.
14. Repeat steps 10 through 13 until you have completed adding flow boxes for all groups in the PDD.
15. Click Auto Layout to display any missed connections.
16. Update the flow boxes as needed.
17. To save your PDD, specify a name in the text field and click Save.

The Generate PDD button appears.
18. Click Generate PDD to start generating a PDD.
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19. Select Yes or No to include an image appendix.
The image appendix includes full-sized screen shots of the steps.

Прим.:  The default images for each step is a zoomed-in snippet of the events interaction point.
The events interaction point is the area on the screen where the user is focused which is typically
denoted by a red circle on the screen shot.

The Process Specifications page appears and the message Generating PDD displays in the bottom left
corner.

20. Click Download PDD to open the PDD document.
The generated Word document is available from your Downloads folder on your machine. The zip file
contains all the images.

21. Review and modify the document, (if needed) and then save your PDD.

Getting started with Privacy Enhanced Gateway
Control the data that the Обнаружение процессов cloud platform receives by using the Обнаружение
процессов Privacy Enhanced Gateway (PEG). PEG redacts sensitive data that is included in video frames
collected by the Обнаружение процессов desktop sensor. This redaction occurs within your own Virtual
Private Cloud (VPC) before the data is forwarded to the Обнаружение процессов cloud for analysis.

Развертывание

Before installing PEG in your network, review the deployment platforms supported by PEG, virtual machine
(VM) size requirements, and storage requirements.

Obtaining PEG

PEG runs as a VM in your VPC. PEG deployments are supported on Microsoft Azure, AWS, and Google
Cloud Platform. Automation Anywhere will provide cloud images for you to deploy.

VM size requirements

The following VM sizes are supported for PEG installation:
• Azure: NC8as T4 v3
• AWS: g4dn.4xlarge
• Google Cloud Platform: N1-highmem-8 with 1 nvidia-tesla-t4 GPU

Прим.:  Each PEG VM can handle 10 sensors per calendar week, with each sensor sending data for
approximately eight hours each day for five days a week.

Common storage requirements

Before you install PEG, ensure that your OS or root disk has 2 TB of nearline SSD storage or more. Encrypt
the disk using your platform’s storage encryption mechanisms.
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Deployment and networking requirements
Learn about the deployment architecture based on certificates for HTTPS connections and the associated
port and DNS requirements.

Развертывание

With this deployment model, all connections to PEG remain within networks that you control.
Architecture

Port requirements

The following table lists the port requirements for ingress and egress IP addresses.
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Порт Протокол Purpose Ingress
private IP

Ingress
public IP

Egress
to public
internet

22 TCP ssh connectivity for Admin #

443 TCP Ingress
Desktop sensor and business
analyst connectivity over HTTPS
(TLS 1.2)
Egress
PEG sends redacted data to
Обнаружение процессов.
Also used to pull down PEG
installer, updates, and so on from
our repositories
Sensor connects directly to
Обнаружение процессов cloud
to get configuration information
only. No collected data is sent
directly from the sensor to the
Обнаружение процессов cloud.

# #

80 TCP Used for redirection from http to
HTTPS (443)

#

DNS requirements

You will provide PEG with an apex domain name that you want to use (for example, example.com). Based
on that, PEG will inform you about the DNS sub domain records that you must create.

Install PEG
Review the checklist before you begin installing PEG in your environment.
Ensure that PEG VM is deployed and that the network connectivity is set up.
PEG installation checklist
The details for each of these steps follow later.
1. Create certificates.
2. Create DNS entries and deploy PEG VM.
3. Configure PEG to work with a proxy (if you require a proxy).
4. Configure PEG by following the regular set of steps.
5. Validate that PEG is running.

Прим.:  Through the installation process, replace the values within angle brackets with your actual values
and remove the angle brackets. Пример.
• <apex domain> might be replaced by example.com.
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• <UID> might be replaced by 123456ab-789c-12de.

Create certificates
Create certificates as part of installing PEG.
You can create certificates by using one of two options.
• Option 1: PEG generates keys and CSRs.
• Option 2: Create your own keys and certificates.

In both cases, you will need the following:
• Unique ID (UID): Each PEG VM you run must have a unique id. You can define the UID to be anything

you want as long as it meets the following criteria:
• Less than or equal to 18 characters in length
• Contains only letters from a to z, numbers from 0 to 9 and/or hyphens
• Must not begin or end with a hyphen
• Must not contain consecutive hyphens
• Совет:  To easily create a UID, take the last 18 characters of a GUID generated from an online

GUID generator.

• The apex domain that you want to use for the PEG DNS names (for example, example.com)

Option 1: PEG generates keys and CSRs
Learn how to use PEG to generate the keys and CSRs for you.
1. Log in to PEG through ssh.

If you do not log in as user named peguser, then ensure that you switch to the peguser per this
command before performing these steps.
sudo su - peguser

2. If you already have a unique ID (UID) by Обнаружение процессов, run the following command:
echo "<UID>" > ~/.kudzu/appliance.txt, where UID is the unique ID that you were
provided. If you do not have a UID, the next few steps will generate one for you.

3. Run cd peg && ./peg_start.sh.
4. Select Cluster management.
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5. Select Generate Certificate Requests.

6. Fill out the options that follow.
7. Exit the menu.
8. Please record the UID value that you see in the output of this command: cat ~/.kudzu/

appliance.txt

The CSRs are located in ~/peg/csr.
9. Create certificates from those CSRs per Common Tasks - Creating the certificates below.

Option 2 - Create your own keys and certificates
Learn how to create keys and certificates before you deploy PEG.
Keys and certificates must be in Base64 PEM format (called openssl or PKCS #8 for the key format in
some systems). Create certificates according to Common Tasks - Creating the certificates. Keys must not be
password protected. Also, ensure that your keys match the file names in the Key File Name column of,
Таблица 3. Mapping of domain names to certificate file names.

Common Tasks - Creating the certificates
Learn how to create Base64 PEM certificates.
When you create the certificates, create six server Base64 PEM certificates (called openssl format in some
systems), with domain names and file names mapped as follows, where the UID is provided to you by
Обнаружение процессов and the apex domain is your apex domain that you will use for PEG. Each
certificate you create must just contain the leaf certificate and not the full chain.

Таблица 3. Mapping of domain names to certificate file names

Домен Cert file name Key file name (Required only if
you created your own keys)

analytics-fiq-<UID>.<apex
domain>

analytics-cert.pem analytics-key.pem

proxy-fiq-<UID>.<apex
domain>

proxy-cert.pem proxy-key.pem

storage-fiq-<UID>.<apex
domain>

storage-cert.pem storage-key.pem

st-fiq-<UID>.<apex domain> st-cert.pem st-key.pem

dlp-fiq-<UID>.<apex domain> dlp-cert.pem dlp-key.pem

es-fiq-<UID>.<apex domain> es-cert.pem es-key.pem

klite-fiq-<UID>.<apex domain> klite-cert.pem klite-key.pem

Прим.:  You can create one certificate with all of the SANs. You can also create just one key if you create
keys if you want. However, you will still need to make sure there are seven copies of that certificate and
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seven copies of that key (if you created keys) named as indicated previously. Do not create a wildcard
certificate.

Create DNS entries and deploy PEG VM
Create DNS entries and deploy PEG VM as part of installing PEG.
Create DNS entries where each domain mentioned in Таблица 3. Mapping of domain names to certificate file
names, points to the PEG VM (PEG must have a static IP or a static domain name).

Configure PEG to work with a proxy
Configure PEG to use a proxy for outbound traffic if required.
Deploy PEG VM

Прим.:  When you deploy the PEG VM, ensure that it has a static IP or at least a static domain name. To
configure the VM static IP address, use the mechanism provided by your VPC provider.

1. Log in to the PEG VM through ssh.
2. Copy your proxy certificate, if one is required, to the following locations:

Прим.:  The proxy file name must have a .crt extension and must be in the Base64 PEM format
(called openssl format in some systems).

• sudo cp <your proxy certificate.crt> /usr/local/share/ca-certificates/

• sudo cp <your proxy certificate.crt> /peg_v/certs/

3. For the OS to load the certificate, run the following command: sudo update-ca-certificates
4. Add the following to the /etc/environment file (including the username and password if

required) using the http_proxy and https_proxy values for your environment.

Прим.:  Although this is not a requirement, the https_proxy value is often the same as the
http_proxy, with the protocol being HTTP for both.

Enter the URL in the following format: <your http/https proxy url> Enter the username and
password if required.http://username:password@host:port/

---

http_proxy=<your http proxy url> https_proxy=<your https proxy url> 

no_proxy="localhost,::1,127.0.0.0/8,0.0.0.0,10.0.0.0/8,192.168.0.0/16,172.16.0.0/12"

5. Log out of your ssh session and then log back in.
This allows the proxy settings to be picked up by the operating system.
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6. Edit the following values as follows in ~/peg/text_pipeline/values-gpu.yaml. (These values
are at the bottom of the file).
Enter the URL in the following format: <your https proxy url>. Enter the username and
password if required. http://username:password@host:port/

If you do not use a certificate for the proxy, fluentd_cert_path should be left as follows: ""

---

has_fluentd_proxy: "true"

fluentd_cert_path: "/peg_v/certs/<your proxy.crt>" 

https_proxy: "<your https proxy url>"

---
7. If you performed the steps in Set up and configure PEG before performing the proxy steps outlined in

the previous steps, perform the following steps:
a) Run cd peg && ./peg_start.sh .
b) Select Cluster Management and press Enter, and then select Load Certificates and press

Enter again.

Set up and configure PEG
Configure PEG for your environment.
If you require a proxy configuration, first perform the steps outlined in Configure PEG to work with a proxy.
Ensure the following:
• Unique ID (UID) provided by Обнаружение процессов
• Platform endpoint provided by Обнаружение процессов
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• PEG-managed certificates: the apex domain that you want to use for the PEG DNS names (for example,
example.com)

1. Log in to PEG through ssh.

Прим.:  If you do not log in as user named peguser, then ensure that you switch to the peguser
before performing these steps: sudo su - peguser.

2. Run the following commands:

echo "<apex domain>"  > ~/.kudzu/apex_domain.txt 

echo "<UID>" > ~/.kudzu/appliance.txt

echo "127.0.0.1" > ~/.kudzu/external_ip.txt

echo "CSRs Generated" > ~/.kudzu/csr_log.txt

3. Modify the existing values in ~/peg/text_pipeline/values-gpu.yaml as seen here. Do not include a slash
at the end of the URL.

external_fluentd_url: "https://<FortressIQ provided platform endpoint>"

external_fluentd_port: "443"

4. Confirm that the PEG VM can reach the Обнаружение процессов platform by running the following:
curl https://<FortressIQ provided platform endpoint>
Отобразится указанное ниже сообщение.
400 Bad Request
'json' or 'msgpack' parameter is required.
Although that result is an error response, it is expected as the curl is not sending a well-formed
message. The response confirms that the server received the request and responded.

5. Copy the PEG certificates that you created to /peg_v/certs/ directory.
Ensure that they are named according to the certificate file names in Таблица 3. Mapping of domain
names to certificate file names.

6. If you also created your own keys, copy the PEG keys that you created to the /peg_v/keys/ directory.
Ensure that the keys are not password protected. Also, ensure that they are named according to the
certificate file names in Table 1.
If you did not create your own keys, the PEG-generated keys are automatically included by PEG.

7. Run ~/peg/scripts/validatecerts.sh.
To confirm that the certificates are valid, continue only if the script passes with "All checks passed!"

8. Reboot to ensure that any updated drivers are applied correctly: sudo reboot now
9. Run cd ~/peg && ./peg_start.sh.
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10. Select Redaction Management and press Enter, and then select Install module and press Enter
again.

Прим.:  Do NOT install cluster.

11. Select Vault Management and press Enter, and then select Install Module and press Enter again.

12. Select Storage Management and press Enter, and then select Initialize Storage and press Enter
again.
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13. Select Cluster Management and press Enter, and then select Load Certificates and press Enter
again.

14. Change the analytics page password. Run the following and enter your password. cd ~/peg/
scripts/ && ./change_elastic_password.rb

Прим.:  The username for logging in to https://analytics-fiq-<UID>.<apex domain> is admin.

15. Add storage users as needed . You will need at least one user with at least read access to confirm that
PEG works. These are the users that can review the redaction of the images. ~/peg/scripts/add-
storage-user.rb .
This script also gives you the option to create users that can edit the pass-and-block (allow/deny) list.

Прим.:  The username that you create corresponds to the Access Key in the login page for https://
storage-fiq-<UID>.<apex domain>. The password corresponds to the Secret Key.

Configuration is now complete.

Validate PEG is running
Verify whether your PEG configuration is operating correctly in review mode.
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To confirm that PEG is running as expected, perform the following steps:
1. In a browser, go to https://storage-fiq-<UID>.<apex domain>.

You will see a screen like this: ("Access Key" = "your username" and secret key = "your password")

2. Log in to https://storage-fiq-<UID>.<apex domain> using a user you created in the
configuration steps previously (by running ~/peg/scripts/add-storage-user.rb on the VM).

3. After you log in, you will see these folders on the left. If you do not, run the "Storage Management"
"initialize storage" steps in the configuration steps. If you still do not see them after that, contact
Обнаружение процессов.
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4. In a browser, go to the analytics URL: https://analytics-fiq-<UID>.<apex domain>
Вы увидите экран, похожий на следующий.

If you do, go to the next step.
5. In a browser, go to https://dlp-fiq-<UID>.<apex domain>.

You will just see a blank page. If you encounter an error or it times out, then there is something
wrong.

6. Install the Neo Sensor on a Windows machine. Open a web page, such as https://www.fortressiq.com
and then click the page several times.

7. After 10 minutes (which is the approximate duration for review images to be generated), log in to
https://storage-fiq-<UID>.<apex domain>. Log in with one of the storage users that you
created previously in the configuration steps.
Note on the folders on the left side:
• fiq-screenshots: Shows the screenshot that PEG received
• forwarded: Shows what the screenshot looks like if it is forwarded. This is populated regardless of

whether it was actually forwarded or not.
• review: PEG adds annotation to the images here to show more clearly what will be redacted. PEG

includes a blue rectangle around where the redacted word previously existed and includes the text
it found above the rectangle.

8. Click the fiq-screenshots folder on the left.
9. Download some of the images from this folder and confirm that they look like the results of your test.
10. Click on the review folder.
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11. Download some of the images from this folder and confirm that they appear to be from your test. If
PEG finds words that must be redacted, PEG includes a blue rectangle around where the redacted
word existed and it includes the text it found above the rectangle, as follows.

If this looks as expected, you have validated that PEG is working in review mode.

PEG modes overview
Redacted images are processed in one of two modes, the review mode and the forwarding mode.
PEG can run in one of two modes:
• Review mode
• Forwarding mode

Review mode

This is the default mode for PEG when it runs for the first time. In this mode, you can review the redacted
images, make changes to the pass-and-block lists, and so on, without PEG forwarding data to the
Обнаружение процессов cloud.

Forwarding mode

When you are comfortable with the results of your review of the images, you can enable the forwarding
mode. After that, PEG will redact sensitive data from newly incoming images and send the redacted data
to the Обнаружение процессов platform. (Existing images from review mode will not be forwarded.)

Switch between modes
Change PEG to the forwarding mode and then back to the review mode.
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By default, PEG initially starts in the review mode.
1. To switch to the forwarding mode:

a) Edit the ~/peg/text_pipeline/values-gpu.yaml file. At the end of the file, change the
forward_to_fluentd value to true and save the changes.
forward_to_fluentd: "true"

b) Push the change to PEG by running the following from any folder:

source ~/peg/scripts/vars.sh

kubectl delete cronjob.batch/text-pipeline-masking-masking-cron -n
 text-pipeline

kubectl get pods --output=jsonpath={.items..metadata.name} -n text-
pipeline -o=name | grep cron | xargs -n1 kubectl delete --grace-
period=0 --force -n text-pipeline

helm upgrade text-pipeline ${text_pipeline_dir} -f ${values_file_t}
 --namespace text-pipeline --set ocr.name=st-fiq-$new_gen_uuid.
$apex_domain --set masking.name=dlp-fiq-$new_gen_uuid.$apex_domain

2. To switch back to the review mode:
a) Edit the ~/peg/text_pipeline/values-gpu.yaml file. At the end of the file, change the

forward_to_fluentd value to false and save the changes.
forward_to_fluentd: "false"

b) Push the change to PEG by running the following from any folder:

source ~/peg/scripts/vars.sh

kubectl delete cronjob.batch/text-pipeline-masking-masking-cron -n
 text-pipeline

kubectl get pods --output=jsonpath={.items..metadata.name} -n text-
pipeline -o=name | grep cron | xargs -n1 kubectl delete --grace-
period=0 --force -n text-pipeline

helm upgrade text-pipeline ${text_pipeline_dir} -f ${values_file_t}
 --namespace text-pipeline --set ocr.name=st-fiq-$new_gen_uuid.
$apex_domain --set masking.name=dlp-fiq-$new_gen_uuid.$apex_domain

Determining content for redaction
PEG redacts words for forwarding based on the pass and block lists.
PEG determines the words that must be redacted base on two lists:
• The pass list
• The block list
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The pass list

PEG comes with a built-in pass list. This list is based on our experience with customers. It contains all the
words that PEG will not redact. Only words in the pass list will be included in images and other data sent to
the Обнаружение процессов platform. Words not on the pass list will be redacted.

The block list

The block list is a list of words that PEG will redact. PEG redacts words based on this list first before it
processes the pass list. The block list is useful in situations where you know words exist on the pass list
that you want redacted, but you do not want to have to modify the pass list. For example, a common use
case is that some people's names are also everyday words that appear on the pass list by default. You can
create a block list of all of the names of your employees or common names in various countries, which can
be obtained from the Internet.

Modify the pass and block lists
Modify the pass list or the block list in the dictionaries folder.
To modify the pass list or the block list, perform the following steps:
1. Log in to https://storage-fiq-<UID>.<apex domain> as a user who has access to edit the pass and

block lists.
2. On the left navigation menu, select the dictionaries folder.
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3. In the dictionaries folder, you will see the block-list.txt and pass-list.txt files as follows.

4. Select the files that you want to edit and download them.

5. Edit the list that you want to edit by using any text editor. Ensure that each word that you add to
either list is followed by space and the number 1.
account 1
customer 1
user 1

Прим.:  Use all lowercase letters for all the words.
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6. Upload the modified files (named "pass-list.txt" or "block-list.txt" accordingly) to the same dictionaries
folder. This will overwrite the existing files and apply your changes. The upload button is at the
bottom-right corner of the page. Click plus (+) sign and then the upload icon.

Manage redaction and forwarding settings from the UI
Manage your forwarding and redaction configurations, and export logs from a simplified UI interface.
You can use the Privacy Enhanced Gateway (PEG) UI interface to perform administrator tasks such as:
1. Update an existing pass list with new words or upload a new list.
2. Set the forwarding settings (true or false) to send redacted data to the platform.
3. Forward existing events that were previously recorded on a users machine.
4. Download and review PEG logs (including logs for the last 24 hours).
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See the following video on how Обнаружение процессов PEG uses a web UI to manage redaction and
forwarding settings instead of running commands on a Command Line Interface (CLI).

Manage redaction list configurations
Learn how to manage your redaction configurations from the Privacy Enhanced Gateway (PEG) UI and
export logs, instead of running commands on the Command Line Interface (CLI).
To update your redaction settings from the UI, perform the following steps:
1. Log in to your PEG klite URL platform as an administrator: https://klite-fiq-<UID>.<apex

 domain>.
2. In the upper right-corner, navigate to Admin > PEG configuration.
3. In General Settings, select Redaction List.
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4. In the Pass List section, select from the following options:
Вариант Действие

Upload new list document Click to upload a new list of words. The words
on this list are not redacted and are sent to the
platform. Words are on this list typically do not
contain sensitive, private information (such as
credit cards numbers, phone numbers, names,
and so on).

Прим.:  Any word that is not on the pass list is
redacted.

<pass-list>.txt a. Click to edit the existing pass list. The list is
saved in the Downloads folder.

b. Open the file, add your changes, and save
the file.

c. Click Upload new list document to upload
the document.

A pop-up message appears notifying you that the
pass list is updated successfully.
Each line can only contain one word. A word can
contain letters, numbers, and symbols, but no
spaces. For words with numbers and symbols,
those words will only be used for comparison if
the Cleaning field is set to false. The words are
case-insensitive. For more details about cleaning,
see step 11.

Text field Enter the words in the text field to update the
existing pass list followed by the Enter key. For
example, to update the pass list to include a
category (such as Support), enter Support in the
text box followed by the Enter key.

5. Click UPDATE to save your changes for the pass list in the text field.
6. Click CLEAR ALL to clear your changes in the text field and start over.
7. In the Block List section, select from the following options:

Вариант Действие

Upload new list document Click to upload a new list of words. The words
are on this list are redacted and not sent to the
platform.
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Вариант Действие

<block-list>.txt a. Click to edit the existing block list. The list is
saved in the Downloads folder.

b. Open the file, add your changes, and save
the file.

c. Click Upload new list document to upload
the document.

A pop-up message appears notifying you that the
block list is updated successfully.
Each line can only contain one word. A word can
contain letters, numbers, and symbols, but no
spaces. For words with numbers and symbols,
those words will only be used for comparison if
the Cleaning field is set to false. The words are
case-insensitive. For more details about cleaning,
see step 11.

Text field Enter the words in the text field to update the
existing block list followed by the Enter key.

8. Click UPDATE to save your changes for the block list in the text field.
9. Click CLEAR ALL to clear your changes in the text field and start over.
10. In the Redaction Word Filter Setting section for Fuzzy Matching, select true to allow Optical

Character Recognition (OCR) some level of variation (fuzzy matching) to consider a word a match. By
default, Fuzzy Matching is set to true and PEG does not require an exact match when comparing a
word with a word on the pass for the block list. Select false to disable fuzzy matching.

Прим.:  When reviewing the redaction levels, you might find some sensitive text (that is not on the
allow list) displaying unexpectedly in the applications screenshots. In that case, select false to disable
fuzzy matching to provide a preferable result.

For example, if OCR reads a word as kello. There is a chance that OCR might be right or wrong in how
it reads the word kello. Kello is not in the pass or block list. Kello might be considered a close enough
match to hello (with the idea that kello was just OCR misreading hello). So, if the word hello is in the
pass list, then the word kello would also be allowed and not redacted.

11. In the Cleaning field, click the drop-down to select true to remove all non-alphabetic (anything not
a letter in the alphabet) from a detected word before comparing it to the words in the dictionaries.
Select false to allow numbers for cleaning. By default, cleaning is set to true.

Прим.:  Cleaning defines whether non-alphabetic characters should be ignored when comparing a
word with the dictionaries.
For example, there are category types (PURCH2A, PURCH2B, and PURCH2C) that are a mix of
numbers and letters that appear in your application screens that should not be redacted. To ensure
that PURCH2A, PURCH2B, and PURCH2C are not redacted, add the words to the allow list and disable
cleaning. PEG will not remove the numbers from these words when comparing with the words on
the allow list. Another example is if you have an account ID, such as SA31LE. If cleaning is set to
true, then PEG removes the number 31 from SA31LE and compares the word, SALE with the words
in the allow list. If SALE is in the allow list, then it is not redacted. However, if you set cleaning to
false, cleaning compares SA31LE with the words on the allow list. Since SA31LE is not in the allow list,
SA31LE is redacted.
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12. Click UPDATE to save your changes.
A pop-up message appears notifying you that your changes are successfully deployed.

13. To export logs from the UI, click Export Logs.
The logs begin generating. After the logs have generated, click Download Logs to unzip the logs
from the Downloads folder. The log files contain information about the system (including logs for the
last 24 hours).

Manage forwarding configurations
Learn how to manage your forwarding configurations from the Privacy Enhanced Gateway (PEG) UI instead
of running commands on the Command Line Interface (CLI).
To update your forwarding settings from the UI, perform the following steps:
1. Log in to your PEG klite URL platform as an administrator: https://klite-fiq-<UID>.<apex

 domain>.

2. In the upper right-corner, navigate to Admin > PEG configuration.
3. In General Settings, select Forwarding.
4. In the Forward to platform field, select true to forward redacted data platform, or select false to

prevent sending forward redacted data to the platform.
By default, the Forward to platform field is set to false.

5. In the Port for forwarding field, the default port number is 443.
We recommend that you leave the default port number as 443 unless you need to change it.

6. In the Forward live records field, select true to forward the live events to the platform, or select
false to prevent sending any events to the platform.
You can use this setting to forward new incoming events. It will not forward existing events that are
masked. If you select false, the incoming events are redacted, but not sent to the platform.

7. In the Forward existing masked records field, select true to forward existing events that were
already recorded but have not been sent to the platform. Select false to prevent sending any existing
events collected on your machine to the platform.
You use this field only to forward data that was previously collected. For example, you might have
collected events for two weeks and forgot to send the events to the platform.

8. In the UTC start date for forwarding field, enter the start date for the observed at date range. The
observed at date range is when the Neo Sensor recorded the event on the machine. You must specify
the range in the UTC time zone.
Based on the date range you enter, PEG forwards previously redacted events that were not already
forwarded to the platform.

9. In the UTC end date for forwarding field, enter the end date for the observed at date range.
10. To use a proxy, click the Use Proxy checkbox.
11. In the https proxy field, enter the proxy URL address to use.

If required, include the username and password in the URL: http://username:password@host:port/
12. Click Deploy.

Manage disk space
Manage disk space by managing the duration for which images are kept in the review folder.
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When the disk usage is over 80 percent, PEG stops processing new messages. To manage the setting in
the review folder, perform the following steps:
1. Add the following block of code to the end of the ~/peg/text_pipeline/values-gpu.yaml file.

(Alternatively, if an entry already exists, modify it.)

 #Archive Info 
 review_retention_days:  365  

The value that you include here will be the number of days for which PEG will keep an image in the
review folder. Replace the number 365 with the number of days for which you want to retain review
images. This will affect only the review images. The original images and the images in the forwarded
folder will not be affected.

2. Push the change to PEG by running the following from any folder:

source ~/peg/scripts/vars.sh

kubectl delete cronjob.batch/text-pipeline-masking-masking-cron -n text-
pipeline

kubectl get pods --output=jsonpath={.items..metadata.name} -n text-
pipeline -o=name | grep cron | xargs -n1 kubectl delete --grace-period=0
 --force -n text-pipeline

helm upgrade text-pipeline ${text_pipeline_dir} -f ${values_file_t} --
namespace text-pipeline --set ocr.name=st-fiq-$new_gen_uuid.$apex_domain
 --set masking.name=dlp-fiq-$new_gen_uuid.$apex_domain

Renew and replace certificates and keys using PEG
In the customer-managed certificates deployment model, certificates and keys that are set to expire are
not renewed and replaced automatically.
When your certificates are set to expire, you must perform the following tasks to renew them:
1. Create a new certificate. You can create a new certificate with two options:

• You can choose to have PEG create the new certificate signing request and the keys, or
• You can create your own certificates and keys. To create your own certificates and keys, see Create

certificates.

2. Upload the new certificate. To upload the new certificate, see Upload the new certificates.

If you choose to have PEG generate new keys and the certificate signing requests, perform the following
steps:
1. Run cd peg && ./peg_start.sh.
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2. Select Cluster Management.

3. Select Generate Certificate Requests.

4. Enter information for the options that follow.
5. Exit the menu.

The certificate signing requests are located in ~/peg/csr.
6. Create certificates from the CSRs that PEG generated. Подробнее см. в разделе Common Tasks -

Creating the certificates.

Upload the new certificates
Learn how to upload the new certificates and keys after they are created.
1. Copy the PEG certificates that you created to the /peg_v/certs/ directory.

Ensure that you name them according to the certificate file names in Таблица 3. Mapping of domain
names to certificate file names.

2. If you also created your own keys, then copy the PEG keys that you created to the /peg_v/keys/
directory.
Ensure that the keys are:
• Not password protected
• Named according to the certificate file names in Таблица 3. Mapping of domain names to certificate

file names

Прим.:  If you choose to have PEG generate the keys, then you do not need to perform this step. The
PEG-generated keys are placed into a folder for you.

3. To confirm that the certificates are valid run ~/peg/scripts/validatecerts.sh.
Continue to Step 4 only if the script displays: All checks passed!

4. To load the latest certificates, run the following command on PEG:

kubectl rollout restart deployment.apps/traefik -n kube-system
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Create image viewer user in analytics portal
Learn how to create an image viewer user and add the user to the analytics portal. Use the image viewer
to find, view, and compare images in PEG.
To create a user in image viewer user and add a user to the klite_read_only role in the analytics portal,
perform the following steps:

Прим.:  The image viewer uses the same logins as those used in the PEG analytics portal.

1. In a browser, go to the analytics portal: https://analytics-fiq-<UID>.<apex domain>
2. Enter your admin username and password.

Your admin password is the same password as the elastic password you set when you configured PEG.
3. Go to Security > Internal users.
4. Click Create internal users.
5. In the Create internal user form, enter your username and password.
6. Click Create.
7. Go to Security > Roles.
8. In the search field, enter klite_read_only.
9. Click klite_read_only.
10. Select the Mapped Users tab, and click Map Users.
11. Select the users you want to map.
12. Click Map.

Users can now log in to the image viewer.

Configuring image viewer
Before you can use the image viewer, you must configure it.
The image viewer requires you to step up the user configuration for first-time users (or if you have to clear
cookies you will have to configure it again).
If you are using PEG for the first time, perform the following steps to use the image viewer.
1. To open the image viewer application, enter the following address in a web browser: https://

klite-fiq-<UID>.<apex domain>

2. In the Configuration Settings dialog box, click Getting started.
3. Enter your klite username and password.

Enter the username and password that was created for new image viewers users. Подробнее см. в
разделе Create image viewer user in analytics portal.

4. For Index Pattern, from the drop-down list, select event_logs.
5. For Image Key Field, from the drop-down list, select screenshot_key.
6. Click Continue.

You can now use the image viewer.

Using image viewer
Use the image viewer to view the images in buckets that are used frequently.
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Before you begin, configure the settings as mentioned in Configuring image viewer. You can use the image
viewer to see images in the following buckets:
• fiq-screenshots: This includes the screenshot that PEG received.
• forwarded: This is what the screenshot looks like when it is forwarded. This is populated regardless of

whether it is forwarded or not.
• review: This includes annotated images. PEG adds annotation to the images to clearly show what will

be redacted. PEG puts a rectangle around where the redacted word previously existed and includes the
text it found above the rectangle.

To review the images, perform the following steps:

Прим.:  These steps show you the buckets that are used frequently, but you can change the selection as
needed.

1. Log in to the image viewer.
The image viewer application is located at your PEG klite URL: https://klite-fiq-<UID>.<apex
 domain>

2. In Bucket 1, click the pencil icon to select the bucket you want.
For example, select fiq-screenshots.

3. In Bucket 2, click the pencil icon to select the bucket you want.
4. Select the timeframe within which you want to review the data.

For example, select Last 15 days.
5. Click Refresh.

If images were sent during the selected timeframe, you can see them now The Bucket 1 version of the
screenshot is on the left. The Bucket 2 version of the screenshot is on the right. You can move the bar
in the middle to the left and the right to see the difference between the two.

Прим.:  If you just sent in an image, it might not be displayed for 10 minutes.

6. Click Filters to filter the data to only look at a specific set of screenshots.
For example, click Add filter to see all notepad screenshots for a specific user.

7. Click Configure Field to select what fields you want to see above the screenshot.
For example, select the Application, Screenshot_key, and Title fields. The image viewer displays
these fields above the screenshot.

8. To export images, select the Export image icon located in the top-right corner of the page.
The Export Images window appears.

9. Select the image range from 1 to 10 using the modal bar.
10. Select the slot from the drop-down list.

For example, select slot 1.
11. For Export Option, choose from the Selected Range option or the Random option.
12. Click Download.

Neo Sensor application
Use the Neo Sensor to record activity on a user’s machine to determine what business processes are
candidates for automation.
The Automation Anywhere Process Discovery Neo Sensor is a lightweight application that integrates
to the machines’ video card to record user activities. The sensor operates in both thick and thin client
applications, and across multiple monitors. You can configure which applications and domains can be used
to capture activity.
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Системные требования

The following system requirements are supported for installing the Neo Sensor:
• Operating Systems

• Physical Desktop: Windows 10, Windows 11
• Citrix VDI: Windows Server 2016, Windows Server 2019

• Memory: 4 GB RAM
• Required software packages: .NET 4.7 or later

Installing Neo Sensor
Learn how to install Neo Sensor on your machine.
Ensure that you install Neo Sensor as a user on your machine, and not on a system level. Any user
with privileges to run an MSI installer, and write permissions to their own user folder, can perform the
installation. If you are using Microsoft SCCM or other software deployment solutions to deploy the MSI,
make sure it is deployed as the user you are deploying it to.
1. Obtain the msi package from Automation Anywhere.
2. Unzip the msi file if you have received it as a zip file.
3. Double-click the Neo2 MSI to launch the Installation Wizard.
4. Щелкните Вперед.
5. Click Next to continue with your organization, endpoint, and port information.

Your customer information is already populated in the fields provided.
6. Click Install on the Ready to Install Обнаружение процессов Neo2 window to begin the installation.
7. Click Finish to exit the Setup Wizard.

The installation is complete and the Neo Sensor is now running. A Neo2 shortcut displays on your
desktop and a pop-up message displays informing you that Neo Sensor has started recording. The
Обнаружение процессов (IQ) icon is displays in your system tray.

8. To quit the recording, right-click the Обнаружение процессов icon in the system tray and click Quit.
A message displays that the recording has stopped. To restart the recording, double-click the
Обнаружение процессов icon Neo2 shortcut on your desktop.

Прим.:  Depending on how the Sensor is configured, the quit option might not be available.

Прим.:  After you enable the Observer and install the Neo Sensor, the recording will automatically
start even after a system reboot. To prevent the Neo Sensor from automatically recording, click the
caret symbol on the taskbar to access the system tray. Right-click the Обнаружение процессов icon
in the system tray and select Quit.

Uninstalling Neo Sensor
Learn how to uninstall Neo Sensor on your machine.
In a centralized deployment, IT will uninstall Neo Sensor. If you choose to manually uninstall Neo Sensor
from your system, perform the following steps:
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Прим.:  Before you begin uninstalling Neo Sensor, ensure that you close the Neo Sensor application on
your system.

Прим.:  Uninstalling Neo Sensor from the Observers machine will not delete the previous recordings from
the Обнаружение процессов Cloud.

1. Navigate to Windows > Control Panel > Programs and Features.
2. Right-click the Обнаружение процессов (IQ) icon and click Uninstall.
3. Click Yes to uninstall.

Прим.:  If you receive a pop-up message informing you that the following applications should be
closed before continuing the install, select, Automatically close applications and attempt to
restart them after setup is complete and click OK.

Installing Neo Sensor in a VDI environment
Learn how to install the Neo Sensor in a Virtual Desktop Infrastructure (VDI) environment and create a
portable package.
Many VDI environments do not allow msi installs that install as the user, especially if they are non-
persistent desktops. If the msi installer does not work in your environment, you must create a portable
installer on a machine with access to the Automation Anywhere Обнаружение процессов platform.
1. Install the Neo Sensor using the MSI installer. For more details, see Installing Neo Sensor.

Ensure that Neo Sensor is running. The Neo Sensor icon displays in the bottom right corner of the
system tray.

2. Navigate to C:\Users\<username>\AppData\Local\Programs\Neo2 and copy the files that
the Neo Sensor installer created in that folder to a different folder.
For example, you can name the folder Neo Sensor files.

3. In Windows Explorer, search in Add or remove programs.
4. Locate the Neo Sensor app and remove the program.

This removes the existing install folder and the registry settings.
5. Copy the Neo Sensor files that you put in a folder to any folder on the VDI server.
6. Create a startup script to start the Neo2.exe on login for users that will run the Neo Sensor.

By default, the Neo Sensor needs write access to the folder it is running from because that is where
the Neo Sensor writes the logs and downloads the configuration from the platform. Since the Neo
Sensor runs in the user space, users need write access to that folder. If you do not want users to have
write access to that folder, you can specify a different writable folder to store the logs and the Neo
Sensor configuration. For more details on storing the logs and sensor configuration to a writable folder,
see Modifying the log and configuration storage location.

Modifying the log and configuration storage location
Learn how to change the location of the logs and the Neo Sensor configuration storage folder to a folder
that is writable to all users who have the Neo Sensor running on their machine.
1. Copy the NeoRemoteConfig.json file to the folder where you want to store it.

The NeoRemoteConfig.json file is one of the Neo Sensor files you should see in your portable
installer folder. The folder you copy it to must be the same writable folder where you want to store the
logs.
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2. Set the log and config file location by specifying the absolute path to the new folder in the
Path.config file. In the folder with the Neo2.exe, there should be a Path.config file.
For example, your Path.config file might contain: z:\user_shared_storage
\neo2_logs_and_config.

You can assign it to an absolute path or can use one special reserved variable {MyDocuments}.
If you use the {MyDocuments} variable in the Path.config file, the logs will be stored in a folder
named Neo2 in the user’s Documents folder.

Прим.:  The Neo Sensor expects to see the NeoRemoteConfig.json in that folder.

Verify Neo Sensor Installation
Use the log files to verify that the Neo Sensor is installed correctly on your machine.
1. While the Neo Sensor is running and in recording mode, click a few times anywhere on your machine.

Clicking a few times on your machine triggers the Neo Sensor to collect and send a screenshot to the
Platform which results in entries in the Neo Sensor logs that you can use for validation.
For more details on enabling the Neo Sensor in recording mode, see Enable and disable the users
recording.

2. From Windows Explorer, open the C:\Users\<username>\AppData\Local\Programs\Neo2
folder. If you changed the default location for the logs, then open the folder you have changed it to.

3. Locate this log file: Neo_<machine name>_<userid>.log
4. Double-click to open the log file.

If the Neo Sensor is working as expected, the following lines display as an example towards the
bottom of the log file. If everything is correct, a job number displays, followed by OK.

2022-11-08 22:03:39.3775 TEST\testuser
 com.FIQ.Neo2.Utility.Network.RawLogForwardingPostConsumer [INFO] Worker
 id: 5b1bd418-2e19-4097-8ba7-31af6f22bd0a, queue size: 0, current job 152
 OK, time elapsed: 0ms, type: fiq.win.keylog

2022-11-08 22:03:39.3775 TEST\testuser
 com.FIQ.Neo2.Utility.Network.RawLogForwardingPostConsumer [INFO] Worker
 id: 61849714-b916-43b7-8878-eced56dd1d65, queue size: 0, current job 151
 OK, time elapsed: 5ms, type: fiq.win.screenshot

If the Neo Sensor is not working, you will see words such as error and failed in the log files output.

Прим.:  If you experience issues, please contact Automation Anywhere for assistance.

2022-11-08 14:13:32.5720 TEST\testuser
 com.FIQ.Neo2.Utility.Network.RawLogForwardingPostConsumer [ERROR]
 Worker id: bbe8547d-3c67-473d-a328-e949a7c25a03, queue size: 13,
 current job 2 failed, type: fiq.win.screenshot, time elapsed:
 10ms, System.AggregateException: One or more errors occurred. ---
> Flurl.Http.FlurlHttpException: Call failed. An error occurred
 while sending the request. POST https://test.example.com:443/
fiq.win.screenshot ---> System.Net.Http.HttpRequestException: An error
 occurred while sending the request. ---> System.Net.WebException: The
 remote name could not be resolved: 'test.example.com'
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Enable and disable the users recording
Learn how to enable or disable the Observers recording in the Обнаружение процессов platform.
1. Log in to into the Обнаружение процессов platform.
2. Navigate to Data > Observers.
3. Identify the Observer you want to enable or disable the recording.
4. From the Actions column, click the drop-down arrow to enable Start Recording for that Observer.

To disable, select Stop Recording for that Observer.

Process discovery by using Discovery Bot
You can use Discovery Bot to identify the processes in your business that can be automated. Discovery
Bot identifies such processes by recording and analyzing user interactions with various systems for
processes, comparing the potential ROI from automating these processes, and creating bots to automate
the processes.

What is process discovery

Process discovery is the first step in automation, in which the processes that can be automated in a
business are identified. Process discovery is a method used to uncover business processes by recording
user interactions with various systems and analyzing the recorded interactions to identify patterns. User
interactions with any of the following types of systems can be recorded and analyzed:
• Enterprise solutions, such as ERP, CRM, business process management (BPM), and ECM
• Personal productivity applications, such as Microsoft Excel and Outlook
• Terminal and virtual environments, such as Citrix XenApp and Remote Desktop

Why use Discovery Bot

Many companies begin their automation projects with manual process discovery and documentation.
Manual review of process documentation requires interviewing business users and mapping work flows
while performing daily operations involving additional resources, which can be time-consuming for
businesses. This additional effort prevents or delays businesses from reaching the decision to automate
their processes and reaping the benefits of automation. As a result, many of the automation opportunities
are left undiscovered. Discovery Bot allows businesses to assess ROI from potential opportunities that can
help with deciding and implementing automation for their processes.

Capabilities

Discovery Bot helps in the following ways:
• Enables automatic process documentation and analysis, thereby saving time and resources
• Identifies the correct processes for automation for business users and citizen developers
• Enables business analysts and RPA developers to accelerate automation and maximize RPA ROI
• Converts automation opportunities into бот prototypes for further development and deployment by the

automation developer
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How Discovery Bot is used

The Discovery Bot administrator creates processes and invites business users through an email invitation
to participate in the recording of these processes. Business users record the steps they perform for
various business processes. Discovery Bot aggregates the recordings and generates a proposed work flow.
The business analyst can adjust the work flow to select and merge steps into branches from different
recordings. From the work flow, the analyst identifies and prioritizes potential automation opportunities
based on ROI. Opportunities are approved by the analyst, and Discovery Bot converts the opportunities to
TaskBots for deployment.
The following image illustrates how Discovery Bot supports your automation journey from process
discovery to bot creation.

To view Discovery Bot tasks in an interactive visual format, see Get started with Discovery Bot.
For an overview of how to get started with Discovery Bot, watch the following video:

See Get started with Discovery Bot.

Начните с Discovery Bot
Discovery Bot enables organizations to accelerate the automation of business processes from process
discovery to бот creation.
• Ensure the system requirements are met.

Необходимые условия для Discovery Bot
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• Install and configure Discovery Bot for users in your organization.
Installing Control Room On-Premises

1. Set up users and assign Discovery Bot roles.
Assign Automation 360 users with the relevant Discovery Bot permissions and associated licenses.
• Discovery Bot пользователей
• Supported licenses for Discovery Bot
• Создание пользователей для Discovery Bot

• Create multi-role users for Discovery Bot
• Create a custom role for Discovery Bot
• Assign the Discovery Bot custom role to a user

2. Set up the business process within your organization.
Create a placeholder for collecting all of the recordings associated for a given process. Invite one or
more users through email notification to a Discovery Bot process recording session.
Create a Discovery Bot process

3. Record the process.
Business users record their work for the associated processes, annotate their steps, and submit for
review a proposed automation work flow.
• Supported applications and browsers for Discovery Bot
• Запись бизнес-процесса Discovery Bot
• Запись процесса Discovery Bot с использованием AARI Assistant

4. Analyze the process.
The relevant business users (subject matter experts (SMEs), RPM or business analysts (BA)) review
the recording data and opportunities associated with the process for specific usage patterns.

Анализ возможностей для автоматизации
5. Create opportunities. Merge specific recordings or steps as required. Prioritize opportunities and

generate боты automatically.
• Анализ возможностей, преобразование в бот и создание PDD
• Using the Filter and Toggle frequency counter options

Discovery Bot пользователей
Various users are involved in the discovery process, and each user's role and responsibility helps in
identifying potential automation opportunities for a business process. The streamlined workflow in
Discovery Bot enables various users to collaborate without changing their operations in a major way.
Discovering processes for automation involves the following users:

Control Room administrator Creates other users, assigns roles to users, and
assigns Discovery Bot licenses for users

Discovery Bot administrator Creates, edits, and deletes processes; also,
associates Discovery Bot roles to and disassociates
Discovery Bot roles from processes
Users with the Discovery Bot administrator privilege
cannot view the recorded data of any process,
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participate in the recording analysis, or create new
opportunities for automation.

Discovery Bot business user Represents the task force in an organization that
will benefit from process automations. The business
user performs the following associated tasks for
business processes:
• Performs the steps in the assigned process and

records the steps
The business user is responsible for recording
the steps in the process that are being reviewed
and evaluated for potential automation
candidates. The business user is invited to
participate in recording session by the Discovery
Bot administrator.

• Edits the Step description (annotated user
text) field for recordings.
For each recording, the business user can
review the recorded screen captures and provide
annotations to capture the business context for
the analyst to review. The business user can
update the Data (keyboard entered) text field
if the information should not be shared with the
analyst, for example, user ID and password.
If the captured steps are not relevant to the
process, the business user can delete the steps
before submitting the recording for review.

Прим.:  After a recording has been submitted, it
cannot be edited.

• Controls the recording of processes using the
media control symbols on the Discovery Bot
recorder.
Users can start, pause, resume, and stop the
recording on demand by using the Discovery Bot
recorder to capture the relevant steps for each
process.

Прим.:  After the recorder has been stopped,
additional steps cannot be inserted into that
recording.

Discovery Bot analyst This user can also be known by other names in
an organization, such as process owner, process
analyst, business analyst, or subject matter expert.
The Discovery Bot analyst is responsible for
reviewing the associated recordings and identifying
potential candidates for automation. The analyst
can perform the following steps:
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• View all approved recordings from assigned
users for a given process.
The analyst cannot edit the recordings; however,
they can merge the necessary variations from
multiple recordings and create an aggregate
view of the process.

• Create opportunities from individual recordings
and the aggregated view created from multiple
recordings, and convert the opportunities into
боты.

• Export a potential opportunity to a Word
document for reference.

While it is not a prerequisite for the analyst to
be knowledgeable about the processes they are
reviewing, it is beneficial because this knowledge
helps in easily selecting and analyzing the
recordings.

Supported licenses for Discovery Bot
Learn about the supported Discovery Bot licenses to ensure business workers are ready to begin using
Discovery Bot.
Лицензии «Обнаружение процессов» предназначены для бизнес-аналитиков и
бизнес-пользователей, работающих с Discovery Bot. Discovery Bot supports two licenses:
• Process analyzer license for the Discovery Bot analyst

This license allows a user to view and manage the metadata from all recordings within the process and
create, view, and manage opportunities created from the recordings.

• Process recorder license for the Discovery Bot user
The process recorder license allows a user to view, record, and submit a process using the Discovery
Bot recorder.

The following table displays detailed information for supported licenses and permissions for Discovery Bot
business workers:

Пользователь
Discovery Bot

System-provided
Discovery Bot role

Функции Discovery
Bot

Discovery Bot license
required

Discovery Bot admin AAE_Discovery Bot
Admin

• Create, view,
update, and delete
processes.

• Assign Discovery
Bot analyst and
business user to
processes.

Нет
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Пользователь
Discovery Bot

System-provided
Discovery Bot role

Функции Discovery
Bot

Discovery Bot license
required

View assigned
processes.

Прим.:  Assigned
processes are only
displayed after the
processes are created
by the Discovery Bot
admin.

Анализатор процессов

View only recordings
(including annotated
steps and metadata)
that they have created
or been assigned to. An
Analyst can also view
recordings of other
users in the process
as long as they are in
Approved state.
If a user is no
longer assigned to
a process, the user
will lose access to the
recordings.

Анализатор процессов

View all recordings
(own and other users),
including metadata and
annotated steps, for a
given process.

Анализатор процессов

• Create, view,
update, and delete
manual generated
aggregation

• View all manually
generated
aggregations

Анализатор процессов

Create and view own
opportunities for a
given process.

Анализатор процессов

Convert an opportunity
to a бот.

Process analyzer for
opportunity creation.
Bot Creator license is
required to convert an
opportunity to a бот.

Discovery Bot analyst AAE_Discovery Bot
Analyst

Export opportunity to
Word.

Анализатор процессов
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Пользователь
Discovery Bot

System-provided
Discovery Bot role

Функции Discovery
Bot

Discovery Bot license
required

Пользователь
Discovery Bot

AAE_Discovery Bot
User

• Using the Discovery
Bot recorder, create
or more recordings
for an assigned
business process.

• Update own
recording to include
annotations for the
steps.

• Delete one or more
steps from own
recording before
submission.

• View only
recordings
(including annotated
steps, keyboard
entered text, and
application type)
that they have
created or been
assigned to. The
user can update the
keyboard entered
text field if the
information should
not be shared
with the analyst
(e.g. user ID and
password).

Прим.:  Assigned
processes are only
displayed after
the processes
are created by
the Discovery Bot
admin.

If a user is no
longer assigned to
a process recording,
the user will lose
access to the
recording data.

Средство записи
процессов
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Необходимые условия для Discovery Bot
Чтобы использовать Discovery Bot для бизнес-процессов своего предприятия, у вас должны быть
рабочая среда Automation 360 и заданные соответствующие зависимости: Bot Agent, расширение
браузера и так далее.

Поддерживаемые версии и требования к серверу

Убедитесь, что у вас установлена правильная версия Control Room. Развертывание Control Room
может быть облачным или локальным.
Убедитесь, что перед установкой были заданы требования к серверу Control Room. См. раздел
Control Room server requirements.

Системные требования
Для процессов записи или назначенных прав создания бот пользователей Discovery Bot убедитесь,
что ваше устройство соответствует указанным ниже системным требованиям.
• Компьютер с ОС Windows поддерживается только для сеансов записи.
• Oracle database is not supported on Discovery Bot.
• Задайте учетные данные локального устройства для любого устройства, подключенного к Control

Room. Это одноразовая настройка для каждого устройства. Убедитесь, что каждое используемое
вами устройство принимает учетные данные в вашем профиле.

• Set user device credentials
• Зарегистрируйте свое устройство и установите последнюю Bot Agent версию на свой компьютер.

Если вы еще не установили Bot Agent, то при первом входе вам будет предложено установить Bot
Agent из вкладки Процессы. Follow the prompts to install the Bot Agent. This will automatically add
your user credentials.

Установка Bot Agent и регистрация устройств
• Для записи процессов с помощью Google Chrome необходимо установить подключаемый модуль

Chrome.

Требования к браузеру для доступа к Рабочая область RPA
• Убедитесь, что ваша среда готова к началу записи и анализа процессов с помощью средства

записи Discovery Bot. Необходимые условия аналогичны для Universal Recorder.
Record a task with the Universal Recorder

• Убедитесь, что требования к средству записи Discovery Bot выполнены.
Supported applications and browsers for Discovery Bot

Обновление настроек прокси-сервера

Чтобы добавить URL-домен Automation Anywhere в список доверенных, необходимо обновить
настройки прокси-сервера. Добавленный URL-домен характерен для вашего региона облака
Automation Anywhere. Если вы используете свой прокси-сервер для доступа к нашему облаку, вы
должны избегать перенаправления на свой прокси-сервер. Удалите все настройки типа проверки
подлинности и принятие политики.
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Требования к установке

Установщик Discovery Bot интегрирован с установщиком Automation 360. Для пользователей
Discovery BotOn-Premises отдельная установка не требуется. Эту задачу выполняет
ИТ-администратор вашей организации. См. раздел Installing Control Room On-Premises.

Прим.:  Перед использованием режима проверки подлинности SQL для подключения к Control Room
убедитесь, что требования к серверу базы данных выполнены: Installing Control Room using Custom
mode.

Теперь после выборочной установке путь к репозиторию по умолчанию можно изменить,
указав новое место на сервере. The default path is: C:\ProgramData\AutomationAnywhere
\ServerFiles. The Process Discovery files now reside in the ServerFiles folder.

Прим.:  Для администратора Control Room. Если задать путь по умолчанию к новому месту, в него
необходимо вручную скопировать и вставить существующие данные.

Созданный PDD-файл для возможности теперь сохраняется локально на вашем сервере продуктом
Automation 360On-Premises. Путь к хранилищу файлов: C:\ProgramData\AutomationAnywhere
\ServerFiles\ProcessDiscovery\opportunity. Существующие PDD-файлы будут
автоматически перемещены в новое место и не будут удалены при переустановке или обновлении
системы Control Room.

Проверка установки

После завершения установки войдите в свой экземпляр Control Room как администратор. Вкладка
Discovery Bot доступна для использования на левой панели.

пакет «Обнаружение процессов»

пакет «Обнаружение процессов» содержит actions, которые записывают различные операции с
объектами, такие как щелчок кнопкой мыши (правой или левой), запись и изменение размеров
окон, которые используются во время сеансов записи процессов. Просмотрите информацию о пакет
«Обнаружение процессов» на странице Просмотреть пакет (Боты > Пакеты > Обнаружение
процессов).
пакет включен в пакеты по умолчанию. При подключении к устройству можно предварительно
загрузить пакет по умолчанию. Предварительная загрузка пакета помогает ускорить запуск средства
записи при первой записи процесса.
actions в пакет недоступны для использования из Bot editor.
Понятия, связанные с данным
Preload пакеты
You can preload пакеты on your local device to shorten the бот runtime.

Upgrade Discovery Bot from Enterprise A2019.15 to later versions
Upgrade Discovery Bot from Enterprise A2019.15 (On-Premises) to a later version for the latest features
and enhancements.
Enterprise A2019.15 provides a separate installer (executable file) for Discovery Bot On-Premises users to
install and use Discovery Bot from the Control Room. Starting from A2019.16, the Discovery Bot installer is
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integrated with the Enterprise A2019 installer. To upgrade from Enterprise A2019.15 to a later version, you
must first uninstall Discovery Bot from your machine and install the Control Room.
1. In your Windows device, go to Apps & features.
2. Search for Discovery Bot.
3. Click Uninstall.
4. Установите последнюю версию Control Room.

Installing Control Room On-Premises

5. From your local machine, log in to your Control Room as an administrator.
The Discovery Bot tab is available for use from the left panel.

Создание пользователей для Discovery Bot
Создайте администратора, аналитика и пользователей Discovery Bot, чтобы начать использовать
функции Discovery Bot для бизнес-процессов фронт-офиса и бэк-офиса. Администратор Control Room
создает этих пользователей и назначает необходимые системные функции.
Убедитесь, что вы приобрели необходимые лицензии Discovery Bot для бизнес-пользователей до
начала создания пользователей: Необходимые условия для Discovery Bot.
Для использования возможностей Discovery Bot пользователю должна быть присвоена
соответствующая функция и лицензии. См. раздел Supported licenses for Discovery Bot.

Прим.:  Функция и разрешения администратора Discovery Bot отличаются от функции
администратора Control Room. См. раздел Discovery Bot пользователей.

1. На локальном компьютере выполните вход в Control Room в качестве администратора.
2. Перейдите в раздел Администрирование > Пользователи.
3. Щелкните Создать пользователя.

Значок расположен в правом верхнем углу таблицы Пользователи.
Отобразится страница Создать пользователя.

4. В разделе Общая информация введите следующие детали пользователя:

Включить пользователя Установите этот флажок, чтобы пользователь
мог немедленно выполнить вход.

Имя пользователя Введите уникальное имя пользователя.
Описание Необязательно. Введите описание

пользователя.
Имя Необязательно. Введите имя пользователя.
Фамилия Необязательно. Введите фамилию

пользователя.
Эл. почта Введите и подтвердите адрес электронной

почты пользователя. Если включен SMTP,
пользователю на этот адрес отправляется
сообщение электронной почты для
подтверждения учетной записи. Щелкните
по URL-адресу в электронном письме,
чтобы выполнить вход в Control Room и
настроить свои учетные данные. На этот адрес
электронной почты будут отправляться все
важные уведомления Control Room.
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5. В разделе Выбрать функции выберите одну из следующих функций в столбце Доступные
функции:
Пользователь Discovery Bot Выберите эту функцию

Администратор AAE_Discovery Bot Admin

Аналитик AAE_Basic и AAE_Discovery Bot Analyst

Прим.:  Функция AAE_Basic требуется для
просмотра или добавления действий в ботах.

Бизнес-пользователь AAE_Basic и AAE_Discovery Bot User

Прим.:  Функция AAE_Basic требуется для
просмотра или добавления действий в ботах,
созданных аналитиком.

6. Щелкните по стрелке вправо, чтобы переместить функцию в столбец Выбрано.
7. В разделе Назначить лицензию на устройство этому пользователю выберите следующее:

Пользователь Discovery Bot Действие

Администратор Сохранить значение по умолчанию Нет для
пользователя.
Этот пользователь имеет доступ только к
Control Room.

Аналитик Назначить Bot Creator - лицензия
разработчика этому пользователю.

Прим.:  Эта лицензия необходима для
преобразования возможности в бот.

Бизнес-пользователь Сохранить значение по умолчанию Нет для
пользователя.
Этот пользователь имеет доступ только к
Control Room.

8. В разделе Назначить другие типы лицензий для этого пользователя? > Лицензии
Discovery Bot выберите следующее:
Пользователь Discovery Bot Действие

Администратор Лицензия не требуется.

Аналитик Выберите лицензию Анализатор процессов.

Бизнес-пользователь Выберите лицензию Средство записи
процессов.

9. Щелкните Создать пользователя.
В таблице «Пользователь» отобразится новый пользователь. Если включен SMTP, новому
пользователю отправляется сообщение электронной почты с приглашением выполнить вход.

Create a Discovery Bot process

Вы можете начать запись бизнес-процессов, используя Discovery Bot. Создайте процесс и назначьте
пользователей для записи и захвата процесса с помощью средства записи Discovery Bot.
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Create multi-role users for Discovery Bot
Create multi-role users when you want to combine system-generated Discovery Bot roles and licenses to
provide additional functionality for your users. Depending on your business requirements, you can combine
up to three Discovery Bot system-generated roles and two process discovery licenses.
Ensure that you have purchased the necessary Discovery Bot licenses for your business users:
Необходимые условия для Discovery Bot.
Для использования возможностей Discovery Bot пользователю должна быть присвоена
соответствующая функция и лицензии.

Прим.:  Функция и разрешения администратора Discovery Bot отличаются от функции
администратора Control Room. См. раздел Discovery Bot пользователей.

Multi-role users will see a different set of menu actions (vertical ellipsis icon) available on a tile for a
process. These actions are different from the standard Discovery Bot user actions that are available on a
tile for a process.
The following actions are available for multi-role users (Admin + Business user + Analyst) on a tile for a
process:

Admin actions • Просмотреть сведения о процессе
• Редактировать сведения о процессе
• Удалить процесс
• Просмотреть/редактировать сведения о

процессе

Business user actions • Начать запись…
The Start Recording icon is displayed on a tile
for a process, or you can select start recording
from the vertical ellipsis icon.

• Редактировать мою запись

Analyst action Analyze processes
Просмотреть возможности процесса

1. На локальном компьютере выполните вход в Control Room в качестве администратора.
2. Перейдите в раздел Администрирование > Пользователи.
3. Щелкните Создать пользователя.

Значок расположен в правом верхнем углу таблицы Пользователи.
Отобразится страница Создать пользователя.

4. В разделе Общая информация введите следующие детали пользователя:

Включить пользователя Установите этот флажок, чтобы пользователь
мог немедленно выполнить вход.

Имя пользователя Введите уникальное имя пользователя.
Описание Необязательно. Введите описание

пользователя.
Имя Необязательно. Введите имя пользователя.
Фамилия Необязательно. Введите фамилию

пользователя.
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Пароль Необязательно. Enter your password and
confirm the password.

Эл. почта Введите и подтвердите адрес электронной
почты пользователя. Если включен SMTP,
пользователю на этот адрес отправляется
сообщение электронной почты для
подтверждения учетной записи. Щелкните
по URL-адресу в электронном письме,
чтобы выполнить вход в Control Room и
настроить свои учетные данные. На этот адрес
электронной почты будут отправляться все
важные уведомления Control Room.

5. In the Select Roles section, select the following roles from the Available roles column to create
multi-role users:
Пользователь Discovery Bot Выберите эту функцию

Admin + Business user AAE_Discovery Bot Admin and
AAE_Discovery Bot User

Admin + Analyst AAE_Basic, AAE_Discovery Bot Admin, and
AAE_Discovery Bot Analyst

Business user + Analyst AAE_Basic, AAE_Discovery Bot User, and
AAE_Discovery Bot Analyst

Admin + Business user + Analyst AAE_Basic, AAE_Discovery Bot
Admin, AAE_Discovery Bot User, and
AAE_Discovery Bot Analyst

6. Click the right arrow to move the roles to the Selected column.
7. В разделе Назначить лицензию на устройство этому пользователю выберите следующее:

Пользователь Discovery Bot Действие

Admin + Business user Сохранить значение по умолчанию Нет для
пользователя.
Этот пользователь имеет доступ только к
Control Room.

Admin + Analyst Назначить Bot Creator - лицензия
разработчика этому пользователю.

Прим.:  Эта лицензия необходима для
преобразования возможности в бот.

Business user + Analyst Назначить Bot Creator - лицензия
разработчика этому пользователю.

Прим.:  Эта лицензия необходима для
преобразования возможности в бот.

Admin + Business user + Analyst Назначить Bot Creator - лицензия
разработчика этому пользователю.

Прим.:  Эта лицензия необходима для
преобразования возможности в бот.
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8. In the Allocate other types of licenses for this user section, select the following:
Пользователь Discovery Bot Действие

Admin + Business user Выберите лицензию Средство записи
процессов.

Admin + Analyst Выберите лицензию Анализатор процессов.

Business user + Analyst Select the Process analyzer and Process
recorder licenses.

Admin + Business user + Analyst Select the Process analyzer and Process
recorder licenses.

9. Щелкните Создать пользователя.
В таблице «Пользователь» отобразится новый пользователь. Если включен SMTP, новому
пользователю отправляется сообщение электронной почты с приглашением выполнить вход.

Create a Discovery Bot process

Log in with your multi-role credentials and create a process. Assign users to record and capture the
process using the Discovery Bot recorder. Review and analyze business processes.

Create a custom role for Discovery Bot
Learn how to create a Discovery Bot custom role that allows users to select Discovery Bot feature
permissions from standard business user roles (Admin, Business user, or Analyst roles), and a single
Control Room admin feature permission for viewing users.
Ensure that you have purchased the necessary Discovery Bot licenses for your business users:
Необходимые условия для Discovery Bot.
Для использования возможностей Discovery Bot пользователю должна быть присвоена
соответствующая функция и лицензии.

Прим.:  Функция и разрешения администратора Discovery Bot отличаются от функции
администратора Control Room. См. раздел Discovery Bot пользователей.

Пример использования The Discovery Bot custom role user is enabled
with Control Room Admin feature permissions for
viewing users, but does not have edit permissions.
The role allows the user to view and manage all
Discovery Bot feature permissions for processes,
recordings, aggregations, and opportunities.
However, the role does not allow the user to view
opportunities or the associated metadata created
by other analysts in the Opportunities tab. The
permission to view all opportunities is not enabled
for the user.

1. На локальном компьютере выполните вход в Control Room в качестве администратора.
2. Go to Administration > Roles.
3. Click Create role.

The icon is located at the top-right of the All roles table.
The Create role page is displayed.

4. Enter a Role name, and optionally enter a Role description.
5. Scroll to the Administration section.
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6. Select View users.
7. Select View roles.
8. Scroll to the Discovery Bot section.
9. Select View assigned process at the parent level.

The child-level permissions are enabled.
10. Select all the following feature permissions: .

a) Discovery Bot process feature permissions at the child level
b) Discovery Bot recording feature permissions at the parent and child levels
c) Discovery Bot aggregation feature permissions at parent and child levels
d) Discovery Bot opportunity feature permissions at the parent and child levels

Прим.:  Do not select View all opportunities.

11. Click Create role.
The Discovery Bot custom role is created.

Assign the Discovery Bot custom role to a user

Assign the Discovery Bot custom role to a user
Create a new user and assign the Discovery Bot custom role you created to the user.
Ensure that you have purchased the necessary Discovery Bot licenses for your business users:
Необходимые условия для Discovery Bot.
Для использования возможностей Discovery Bot пользователю должна быть присвоена
соответствующая функция и лицензии.

Прим.:  Функция и разрешения администратора Discovery Bot отличаются от функции
администратора Control Room. См. раздел Discovery Bot пользователей.

Custom role users will see a different set of menu actions (vertical ellipsis icon) available on a tile for
a process, depending on the permissions given to users. These actions are different from the standard
Discovery Bot user actions that are available on a tile for a process.
For this custom role use case, the following actions are available on a tile for a process:

Admin actions • Просмотреть сведения о процессе
• Редактировать сведения о процессе
• Удалить процесс

Business user actions • Начать запись…
The Start Recording icon is displayed on a tile
for a process, or you can select start recording
from the vertical ellipsis icon.

• Редактировать мою запись

Analyst action Analyze processes

1. На локальном компьютере выполните вход в Control Room в качестве администратора.
2. Перейдите в раздел Администрирование > Пользователи.
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3. Щелкните Создать пользователя.
Значок расположен в правом верхнем углу таблицы Пользователи.
Отобразится страница Создать пользователя.

4. В разделе Общая информация введите следующие детали пользователя:

Включить пользователя Установите этот флажок, чтобы пользователь
мог немедленно выполнить вход.

Имя пользователя Введите уникальное имя пользователя.
Описание Необязательно. Введите описание

пользователя.
Имя Необязательно. Введите имя пользователя.
Фамилия Необязательно. Введите фамилию

пользователя.
Пароль Необязательно. Enter your password and

confirm the password.
Эл. почта Введите и подтвердите адрес электронной

почты пользователя. Если включен SMTP,
пользователю на этот адрес отправляется
сообщение электронной почты для
подтверждения учетной записи. Щелкните
по URL-адресу в электронном письме,
чтобы выполнить вход в Control Room и
настроить свои учетные данные. На этот адрес
электронной почты будут отправляться все
важные уведомления Control Room.

5. In the Select Roles section, select the AAE_Basic role and the Discovery Bot custom role you
created from the Available roles column.

6. Click the right arrow to move the roles to the Selected column.
7. In the Allocate a device license to this user section, select the Bot Creator - Development

license.
8. In the Allocate other types of licenses for this user section, select the Process analyzer and

Process recorder licenses.
9. Щелкните Создать пользователя.

В таблице «Пользователь» отобразится новый пользователь. Если включен SMTP, новому
пользователю отправляется сообщение электронной почты с приглашением выполнить вход.

Create a Discovery Bot process

Log in with your custom role credentials and create a process. Assign users to record and capture the
process using the Discovery Bot recorder. Review and analyze business processes.

Create a Discovery Bot process
Create a Discovery Bot process and assign users to record and analyze a process for your automation
requirements.
• This task is performed by the Discovery Bot admin who manages the creation, deletion, and editing of

Discovery Bot processes.

Прим.:  Пользователи с несколькими функциями и пользовательскими функциями также
могут выполнять эту задачу в зависимости от функций или разрешений, предоставленных
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пользователям. Вы увидите другой набор действий меню (значок с тремя вертикальными
точками), доступный на плитке для процесса.

• Ensure the Process recorder license is allocated to Discovery Bot users assigned to recording a
process.

• Ensure the Process analyzer license is allocated to the Discovery Bot analyst assigned to analyzing a
process.

• Create a process and assign users:
a) From your local machine, log in to your Control Room as a Discovery Bot administrator.
b) Выберите Discovery Bot > Процессы.
c) Click Create Process.

The Create process page is displayed.
d) In the General Details tab, enter a Process Name .

Special characters are not supported. Creating a process with a duplicate name is not supported.
e) Необязательно: Enter a Process Description.
f) Click Next to assign users to a process.
g) Необязательно: In the Users tab, select the Discovery Bot business user or analyst from the list

of Available users.
h) Click the right arrow to move the roles to the list in the Selected column.
i) Click Next to view the invitation that is sent to users to begin recording processes.
j) Click Create Process.
k) Click Close to exit the page and return to the Processes page.

Прим.:  An email invitation is sent to assigned users (new users or users added at a later time) to
begin a Discovery Bot process recording session.

The newly created process is displayed in the Processes page on a tile.
For users, all of their assigned processes are available for viewing from the Processes page. Use
the search field to help you locate a specific process by name. The field is not case-sensitive. For
users, use the field to search on a process you are assigned to. For admin users, use the field to
search on all processes. Use the sort field to help you locate a process tile quickly. Click the drop-
down to sort for a process tile based on the process name in alphabetical order or you can sort
in the order of newest process created to oldest process and vice versa. The tile for a process
displays the following information for an admin user:

Process tile Описание

Записи The number of the recordings captured
and stored for a process by users.

Цикл процесса The average time, in minutes and
seconds, across all recordings captured
for a process.
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Process tile Описание

Vertical ellipsis icon (three dots)

Прим.:  You might see a different set
of menu actions available from the tile if
you are a Discovery Bot standard user,
multi-role user, or custom role user.

View, edit, or delete information for a
process.
• Click View process details to view

more information about a process,
edit and update information, and save
changes.

• Click Edit process details to edit a
process. Enter your changes and click
Save changes. Click Close to return
to the Processes page.

Прим.:  The name of the process
cannot be changed.

• Click Delete process to delete a
process. A message window appears.

• Click Yes, delete to delete a process.
All recordings and associated data are
permanently deleted. This cannot be
undone.
Click No, cancel to return to the
Processes page.

• Click View/edit process details
to view more information about a
process, edit and update information,
and save changes. To edit a process,
click Edit. Enter your changes and
click Save changes. Click Close to
return to the Processes page.

Прим.:  The name of the process
cannot be changed.

• Click Edit my recording to edit and
review recordings.

• Click View process opportunities
to view auto-generated or custom
opportunities created from the
Opportunities tab.
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• Create a process and add users at a later time:
a) From your local machine, log in to your Control Room as a Discovery Bot administrator.
b) Выберите Discovery Bot > Процессы.
c) Click Create Process.

The Create process page is displayed.
d) In the General Details tab, enter a Process Name.

Special characters are not supported. Creating a process with a name previously used for another
process is not supported.

e) Необязательно: Enter a Process Description.
f) Click Create Process to create a process without assigning users.
g) Click Close to exit the page and return to the Processes page.

• Update an existing process and add users.
a) From your local machine, log in to your Control Room as a Discovery Bot administrator.
b) Выберите Discovery Bot > Процессы.
c) Go to the process you want to edit.
d) Click Edit from the Options icon.
e) In the Edit process page, click Next to assign users to a process.
f) In the Users tab, select the Discovery Bot business user or analyst from the list of Available

users.
g) Click the right arrow to move the roles to the list in the Selected column.
h) Щелкните Сохранить изменения.
i) Click Next to view the invitation that is sent to users to begin recording processes.
j) Click Close to exit the page and return to the Processes page.

Прим.:  An email invitation is sent to assigned users (new users or users added at a later time) to
begin a Discovery Bot process recording session.

The newly created process is displayed in the Processes page on a tile.

Запись бизнес-процесса Discovery Bot

Log in to your Control Room as a Discovery Bot user and record a business process assigned to you.

Supported applications and browsers for Discovery Bot
Learn about supported applications and browsers to ensure your environment is ready before you begin
using the Discovery Bot recorder.

About the Discovery Bot recorder

The Discovery Bot recorder is similar in function to the Automation 360 Universal Recorder with one
significant difference: pre-selection of the application to be used for recording is not required.
The Discovery Bot recorder captures data across many user interface (UI) objects such as Windows
applications, native applications, executable file, or browser window on PC devices and machines or virtual
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machines running Windows OS. Use the Discovery Bot recorder to capture, read (data extraction), write
(data entry), and click (left or right) operations when working across various operations. A single recording
per user can capture up to 8 hours of user actions.
The Discovery Bot recorder displays the performed action by using highlighter. Щелкните элемент
управления объектом, например кнопку, поле формы или таблицу. Красный контур выделяет
элемент управления, когда вы наводите на него курсор мыши, чтобы захватить действие.
Во время записи можно выполнять следующие действия: двойной щелчок, перетаскивание, щелчок
и удержание, а также выделение текста. Действия, выполняемые с помощью нажатий клавиш,
отображаются в поле Данные.

Supported applications and browsers

The recorder supports system, web, and virtual applications including the following:

Приложения • Microsoft applications: Edge, PowerPoint, Excel,
Word, Outlook, Calculator, Notepad, Notepad++,
Teams

• Zoom
• Snagit
• Java applet, web start, and desktop applications

that run using Java Runtime Environment
(JRE) 6, 7, 8, 9, 10, and 11 (32-bit and 64-bit
versions)

• Microsoft Active Accessibility and UI automation
based applications

• Oracle EBS and Forms
• SAP 730, 740, 750 and 760 versions.
• Citrix Virtual Apps

Браузеры • Internet Explorer версии 11
• Google Chrome

Прим.:  Chrome plug-in must be installed
to record processes. If the Chrome plug-in is
removed, you must manually add and re-enable
the plug-in. Google Chrome browser extension
requirements

Рабочий стол The desktop refers to the device screen when all
application and browser windows are minimized.

Панель задач The taskbar is the horizontal or vertical bar
containing icons of open applications and browsers,
as well as the notification area. You can capture
application, browser, system, and other icons, for
example such as the clock and calendar, volume,
and Wi-Fi.
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Запись бизнес-процесса Discovery Bot
Записывайте, захватывайте и аннотируйте шаги бизнес-процесса с помощью средства записи
Discovery Bot. Запись процесса позволяет аналитику Discovery Bot просмотреть все записанные шаги
для количественного и сравнительного анализа. Эти шаги вместе с полученными метаданными и
действиями пользователей помогают аналитику принять решение о создании возможностей и боты.
• Эта задачу выполняет пользователь Discovery Bot. Он записывает назначенные бизнес-процессы

и отправляет их на проверку и анализ.

Прим.:  Пользователи с несколькими функциями и пользовательскими функциями также
могут выполнять эту задачу в зависимости от функций или разрешений, предоставленных
пользователям. Вы увидите другой набор действий меню (значок с тремя вертикальными
точками), доступный на плитке для процесса.

• Перед использованием средства записи Discovery Bot убедитесь, что вы настроили учетные
данные устройства и установили последнюю версию Bot Agent на компьютере.

• Проверьте, что компьютер, на котором вы собираетесь выполнять запись, надлежащим образом
зарегистрирован.

Необходимые условия для Discovery Bot

1. Запись бизнес-процесса:
a) С локального компьютера войдите в систему Control Room как бизнес-пользователь

Discovery Bot.
b) Выберите Discovery Bot > Процессы.

Отобразится страница Процессы со всеми процессами, назначенными пользователю для
записи.

c) Щелкните значок Начать запись на плитке, связанной с процессом, который вы хотите
записать.

Прим.:  Чтобы начать запись процесса, вы также можете выбрать Начать запись из меню,
которое открывается щелчком по значку с тремя вертикальными точками.

Появится окно с сообщением о том, что запись началась и что вы предоставляете доступ
к экрану. В окне Средство записи Discovery Bot отображаются опции Приостановить
и Остановить. Приостанавливайте и возобновляйте запись по мере необходимости. При
первой записи процесса средству записи может потребоваться несколько минут на запуск.

d) Выполните действия для записи.
Например, откройте приложение и заполните форму или откройте браузер и выполните
поиск сайта. Щелкните элемент управления объектом, например кнопку, поле формы или
таблицу. Красный контур выделяет элемент управления, когда вы наводите на него курсор
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мыши, чтобы захватить действие. Красный контур означает, что средство записи готово, и
вы можете выполнить следующее действие в записи процесса.
Во время записи можно выполнять следующие действия: двойной щелчок, перетаскивание,
щелчок и удержание, а также выделение текста. Действия, выполняемые с помощью
нажатий клавиш, отображаются в поле Данные.

e) Нажмите Остановить, чтобы завершить запись.
Вы можете в любое время нажать Отменить запись, чтобы отменить запись.
Подождите несколько секунд, пока средство записи не завершит работу. Пополнятся
сведения в плитке для процесса. Теперь в них входит новая запись в разделе Записи.

Прим.:  После остановки записи добавлять к ней дополнительные шаги невозможно.

Прим.:  В одной записи может быть захвачено не более 8 часов действий пользователя.

f) Введите имя записи в соответствующее поле.
Ограничение по количеству символов — 50. Поддерживаются специальные символы.

g) Чтобы сохранить изменения, щелкните Сохранить.
h) Щелкните Отменить, чтобы отменить запись.

Прим.:  Если вы отмените запись, восстановить ее будет невозможно.

2. Просмотрите записанные шаги, аннотируйте их и отправьте запись процесса на проверку
аналитику Discovery Bot:
a) На странице Процессы выберите процесс, щелкнув имя нужного процесса или щелкнув в

любом месте плитки процесса. From Processes, click the vertical ellipsis icon and select Edit
my recording to edit and review recordings.
Если щелкнуть плитку процесса или имя процесса, появится страница Возможности. Для
аналитика отображаются только одобренные записи с вкладки Возможности.
Для пользователей с несколькими функциями и пользовательскими функциями Discovery
Bot: щелкните значок с тремя вертикальными точками и выберите Редактировать мою
запись, чтобы проверить и отредактировать записи. Если щелкнуть плитку процесса или
имя процесса, появится страница Просмотреть процесс. Для аналитика отображаются
только одобренные записи на странице Просмотреть процесс.
Появится страница Записи с таблицей Записи слева и сведениями о конкретной записи
справа. В таблице приведена следующая информация.

Записи Описание

Записи (количество) (количество
выбранных)

Количество записей, добавленных
пользователями.

Настроить столбцы Щелкните значок таблицы, чтобы
отобразить или скрыть столбцы
(«Идентификатор», «Статус», «Цикл
процесса» и «Средство записи»)
или по необходимости изменить
расположение строк заголовка —
справа или слева.
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Записи Описание

Идентификатор Идентификационный номер записи
в базе данных. Система собирает
и последовательно увеличивает
индекс для каждой записи, сделанной
пользователями.

Прим.:  Для поиска конкретной
записи выберите Идентификатор
и введите номер идентификатора в
строке поиска.

Имя Имя записи.

Статус Статус записи
• Ожидание. Исходное состояние.
• Одобрено. Внесение правок,

необходимых для пользователей,
завершено, и запись готова к
проверке аналитиком.

• Ошибка. При сохранении записи в
системе произошла ошибка.

• Отклонено. В настоящее время не
используется.

Прим.:  Чтобы выполнить поиск
по статусу процесса, выберите
Статус и выберите нужный статус из
раскрывающегося списка.

Цикл процесса Продолжительность записи в минутах
и секундах, исключая время, когда
средство записи было поставлен на
паузу.

Средство записи Имя пользователя, создавшего
запись.

Прим.:  Для поиска пользователей,
назначенных записи, выберите
Средство записи из
раскрывающегося списка и введите
имя пользователя в строке поиска.
Регистр учитывается.

3. Из таблицы Записи выберите запись, чтобы просмотреть все записанные шаги. На панели
справа, в заголовке, отображаются сведения об идентификаторе записи, включая общее
количество шагов, захваченных во время сеанса записи, имя записи, время процесса и текущий
статус записи.
Каждый записанный шаг включает: скриншот с опцией Экран (значок), тип приложения,
данные (текст, введенный с клавиатуры) и поля описания шагов (аннотированный текст
пользователя).
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4. Необязательно. Чтобы создать описание для записи, щелкните в области Описание.
Отобразится поле Описание. С его помощью предоставьте аналитику контекст и цель записи.
Ограничение по количеству символов — 255. Введенное описание отображается также в PDD.

5. Щелкните Сохранить, чтобы сохранить описание, которое вы ввели в поле Описание.
6. Необязательно. Щелкните значок Экран, чтобы отобразить или скрыть скриншот.

Воспользуйтесь значком опции Экран, если вы не хотите делиться персональными данными,
показанными на изображении, с аналитиком Discovery Bot, пользователями с несколькими
функциями и пользовательскими функциями. Чтобы удалить с изображения личную
информацию, например имя пользователя и пароль, отредактируйте поле Данные перед
отправкой записи на проверку аналитику.

Прим.:  Если вы скроете изображение и нажмете Отправить, вы не сможете отобразить
изображение снова.

7. Щелкните скриншот, чтобы показать изображение в полном размере.
Скриншот показывает состояние приложения в момент выполнения соответствующего
действия. Красным контуром выделены места, где вы выполняли такие действия, как щелчок и
удержание и выделение текста. Вы не можете редактировать скриншот. Щелкните изображение,
если хотите отобразить скриншот в большем размере. Узнайте больше о действии шага в
модальном окне. Щелкните разбивку на страницы, расположенную под изображением, чтобы
выбрать номер шага, или используйте стрелки вправо или влево для быстрого отображения
всех созданных изображений. Для действий, не захватываемых средством записи, таких как
двойной щелчок, перетаскивание, щелчок и удержание, вы можете задокументировать для
аналитика отдельные шаги в поле Описание шага.
Продолжительность записанного шага отображается в минутах и секундах под скриншотом.
Используйте эту информацию, чтобы определить, какой шаг или последовательность шагов
лучше всего подходит для автоматизации. Например, если последовательность шагов требует
больше времени для выполнения, вы можете автоматизировать этот первый шаг для процесса,
чтобы сэкономить усилия.
• Щелкните значок Скрыть изображение, чтобы скрыть изображение.

Изображение не будет отправлено на проверку аналитику. Щелкните X, чтобы закрыть кадр.
Чтобы сохранить выбранные параметры, щелкните Сохранить.

• Щелкните Показать изображение, чтобы отобразить изображение.
Изображение будет передано на проверку аналитику. Щелкните X, чтобы закрыть кадр.
Чтобы сохранить выбранные параметры, щелкните Сохранить.

8. Необязательно: Измените название приложения, используемое в записи процесса, в текстовом
поле Приложение.
В поле Приложение указывается название приложения, в котором было выполнено действие.
При необходимости пользователь, сделавший запись, может изменить название.

9. Необязательно: Измените введенный с клавиатуры текст, используемый в записи процесса, в
текстовом поле Данные.
В поле Данные указываются любые данные, введенные пользователем в ходе выполнения
данного шага записи.

Прим.:  После ввода данных с клавиатуры необходимо щелкнуть левой или правой кнопкой
мыши. Для любого шага, в ходе выполнения которого были введены данные, вы можете внести
изменения в данные в поле Данные. Вы не можете вводить данные для шагов, для которых не
было введено никаких данных во время фактической записи процесса.
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10. Необязательно: Обновите контекст, связанный с шагом в текстовое поле Описание шага.
В поле Описание шага указывается дополнительное описание, которое вы хотите
предоставить относительно выполняемой операции. Ограничение по количеству символов —
2000.

11. Необязательно. Удалите шаги, которые не требуется включать в запись процесса.
12. Повторите описанные выше действия для каждого шага при необходимости.
13. Необязательно: Чтобы сохранить изменения, щелкните Сохранить.

Используйте опцию Сохранить, когда вы хотите отредактировать и сравнить данные записи
(включая приложение, текст, введенный с клавиатуры, и текстовые поля аннотаций) в
нескольких записях, сохраненных в таблице Записи.

14. Необязательно. Щелкните Удалить, чтобы удалить запись для процесса.
Используйте опцию Удалить, если вы не хотите передавать данные записи на проверку
аналитику.
Запись и связанные с ней данные удаляются со страницы Записи для процесса.

15. Щелкните Отправить.
Запись отправляется аналитику на проверку и одобрение.

Прим.:  После отправки редактировать запись и вносить в нее дополнительные изменения
нельзя.

16. Чтобы экспортировать данные о возможности в документ определения процесса (PDD) с тем
же именем, что и возможность, щелкните Загрузить. Выберите тип документа PDD (Word или
PDF), который требуется экспортировать. Документ PDD включает в себя блок-схему записи
процесса и время на каждом отдельном этапе в часах, минутах и секундах.
Когда создается возможность, PDD автоматически начинает обработку в фоновом режиме.
При создании PDD поле изменяет значение с «Обработка PDD» на Загрузить. Теперь вы
можете загрузить данный документ. Также бизнес-пользователю на указанный в файле адрес
электронной почты отправляется уведомление. Если при загрузке PDD возникла ошибка,
щелкните кнопку Загрузить еще раз, чтобы снова сгенерировать PDD.

Прим.:  Пользователи с несколькими функциями получают по электронной почте два
уведомления для экспортированных данных: одно для данных записи и одно для данных
возможностей.

Прим.:  Загрузить возможность может только ее владелец. Другим загрузка возможности
недоступна.

На вашем компьютере документ сохраняется в папке, настроенной в браузере для загрузок.

Анализ возможностей для автоматизации
Войдите в Control Room как аналитик Discovery Bot для проверки и анализа записей, чтобы при
необходимости создать возможности или боты.

Запись процесса Discovery Bot с использованием AARI Assistant
Используйте AARI Assistant для записи бизнес-процессов Discovery Bot без входа в Control Room.
• Перед использованием средства записи Discovery Bot проверьте, что вы задали учетные данные

устройства и установили последнюю версию Bot Agent на свой компьютер.

Прим.:  При установке Bot Agent значок AARI будет загружен на ваш рабочий стол.
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• Проверьте, что компьютер, на котором вы собираетесь выполнять запись, надлежащим образом
зарегистрирован.

Необходимые условия для Discovery Bot
• Проверьте, что в настройках браузера разрешены перенаправления и всплывающие окна для

доступа к Control Room.

1. Дважды щелкните по значку AARI, чтобы открыть AARI Assistant.
2. Используйте учетные данные Automation 360 для входа в приложение.
3. Щелкните Процессы.

Отобразится страница Запись процессов со всеми процессами, назначенными и доступными
пользователю.

4. Когда вы захотите начать запись процесса, щелкните Начать запись.
Появится окно с сообщением о том, что запись началась и что вы предоставляете доступ к
экрану. В окне Средство записи Discovery Bot отображаются опции Приостановить и
Остановить. Приостанавливайте и возобновляйте запись по мере необходимости. При первой
записи процесса средству записи может потребоваться несколько минут, чтобы начать запись.

5. Выполните действия для записи.
6. Чтобы завершить запись, нажмите Остановить.

You will be redirected to the Control Room to review and edit your recording before you submit it.
Запись бизнес-процесса Discovery Bot

7. Чтобы просмотреть шаги предыдущих записей и отправить их, щелкните Предыдущие
записи.
Вы будете перенаправлены в Control Room для просмотра записей.

Анализ возможностей для автоматизации
Рассмотрите возможности и данные записи процессов с использованием графиков и диаграмм,
которые помогут проанализировать и понять потенциальные возможности и предоставляемые ими
преимущества, а также экономию при наличии автоматизации или ее отсутствии.

Возможности

Под заголовком «Возможности» представлен снепшот записей и данных о возможностях,
полученных всеми пользователями для назначенных процессов. Под заголовком Возможности
отображаются указанные ниже данные.

Поле Описание

Экономия Потенциальная экономия (годовая экономия
или экономия за один прогон), связанная с
возможностью

Количество возможностей Количество возможностей, включающих
выбранные записи

Количество вариантов процесса Количество ответвлений, включенных в
возможность

Среднее время цикла процесса Средняя продолжительность записей,
предоставленных для процесса
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Поле Описание

Участники Количество пользователей, представивших
записи для процесса

Эволюция возможностей

Используйте план развития возможностей в качестве руководства для выбора возможностей,
которые будут автоматизироваться в первую очередь. В каждом квадранте отображается
следующее:
• Продолжить сейчас. Для таких возможностей характерна максимальная выгода и простота

реализации.
• В долгосрочной перспективе. Такие возможности дают хорошую рентабельность инвестиций,

но для их реализации потребуется время. Кроме того, для их автоматизации требуется больше
усилий по внедрению.

• Приостановлено. Небольшое преимущество автоматизации и большое время внедрения.
Рекомендация: не автоматизировать.

• Быстрые результаты. Всегда реализуйте такие возможности в первую очередь, чтобы придать
импульс.

Использование приложения

На кольцевой диаграмме отображается количество приложений, используемых в выбранных
записях. Сведения об использовании приложения показаны в таблице справа от графика в
указанном ниже формате. Приложение | минуты секунды | процентное отношение. Процентное
отношение представляет собой процент использования приложения по отношению к общему
количеству всех используемых приложений.

Пример использования

Эта информацию позволяет быстро проанализировать участие пользователей, а также сложность
и изменчивость процесса. Чем больше приложений, тем выше сложность и изменчивость
анализируемого процесса. Среднее время цикла процесса даст быстрое представление о
продолжительности процесса в пределах ожидаемого времени обработки. Если фактический
показатель цикла процесса выше по всему количеству приложений, это может указывать на то, что
этот процесс больше подходит для автоматизации, и она поможет повысить эффективность.

Время цикла процессов

На этом графике отображается время, связанное со средним циклом процесса (в минутах) для
каждого процесса и каждого пользователя.

Пример использования

Используйте эту информацию, чтобы понять, какие процессы занимают больше всего времени
и, следовательно, потенциально дадут больше экономии, если их автоматизировать. Например,
аналитики могут узнать, почему запись процесса заняла больше времени или была завершена за
более короткий период для одного конкретного участника, и сравнить эту информацию с другими

© 2023 Automation Anywhere. All rights reserved.     2370



    Automation Anywhere - Сборка

участниками. Эта информация помогает сузить круг записей процессов и изучить их на предмет
неэффективности, что может улучшить или расширить возможности для автоматизации.

Количество этапов в каждом процессе

На этом графике отображается среднее количество выполняемых вручную шагов в каждом процессе
и для каждого пользователю. Используйте эту информацию, чтобы сравнивать количество шагов
в разных процессах. Процессы с большим количеством выполняемых вручную шагов — более
вероятные кандидаты на автоматизацию.

Анализ возможностей, преобразование в бот и создание PDD
Анализ потенциальных возможностей, генерируемых системой, создание пользовательских
возможностей на основе генерируемых системой возможностей и преобразование их в боты. Также
можно экспортировать данные о возможностях в документ Microsoft Word или PDF для справки.
Возможности автоматизации бывают двух типов: генерируемые системой и ручные. Генерируемые
системой возможности, также известные как автоматически генерируемые возможности, создаются,
когда для процесса пользователем утверждается по крайней мере одна запись. Автоматически
созданные возможности можно сразу же начать анализировать на странице Возможности для
записи. Команда Загрузить для создания документа в формате Microsoft Word или PDF недоступна
для автоматически создаваемых возможностей. Создание ветви и объединение шагов в ветвь для
автоматически генерируемых возможностей недоступно из диаграммы процесса.
Ручные возможности, также известные как пользовательские возможности, создаются на основе
автоматически генерируемых возможностей. Пользовательская возможность позволяет просмотреть
текущие и недавно добавленные записи от пользователей и принять решение о принятии или
отклонении новых изменений в существующей диаграмме процесса. При добавлении в диаграмму
процесса шагов из другой записи также можно создать ветвь. Команда Загрузить доступна
для использования, если требуется загрузить документ Microsoft Word или PDF с данными о
пользовательских возможностях для справки.
• Эта задача выполняется аналитиком Discovery Bot, который отвечает за просмотр и анализ

соответствующих записей бизнес-процессов.
• Ensure the analyst is assigned a Process analyzer license and the AAE_Discovery Bot Analyst role

before processes are analyzed.
Supported licenses for Discovery Bot
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• Убедитесь, что аналитику назначена лицензия Bot Creator для преобразование возможностей в
боты.
Supported licenses for Discovery Bot

1. Проанализируйте данные на вкладке Возможности:
a) С локального компьютера войдите в систему Control Room как аналитик Discovery Bot.
b) Выполните переход Discovery Bot > Возможности.

На странице Возможности отображаются все созданные вами возможности. Вы можете
настроить отображение пункта меню по своему усмотрению с помощью значка Настроить
столбцы. В таблице приведена указанная ниже информация.

Поле Описание

Имя возможности Имя, созданное для возможности.
Чтобы отличить возможность,
генерируемую автоматически, от
пользовательской возможности,
имя первой начинается с названия
процесса, а после дефиса
добавляется OPPORTUNITY.

Имя процесса Имя, созданное для процесса.

Тип Тип возможности, созданной для
процесса. Возможный тип: «Авто»
или «Пользовательский».

Путь Тип пути, указанный на основе
настройки Фильтр, примененной
к возможности. Автоматически
генерируемые возможности
используют значение фильтра
по умолчанию «Наиболее
распространенный путь».

Дата создания Когда появилась данная
возможность.

Дата изменения Дата изменения возможности
аналитиком. Дата изменения
может возникать при обновлении
возможности или при создании
пользовательской возможности.

Владелец Имя владельца процесса. Владельцем
процесса может быть система или
аналитик.

Кол-во записей Количество записей для процесса,
связанного с возможностью.

Кол-во применений Количество приложений,
использованных в сеансе записи,
связанном с данной возможностью.

Цикл процесса Продолжительность сеанса записи,
связанного с возможностью.
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Поле Описание

Кол-во пользователей Количество пользователей,
принявших участие в сеансе записи
для данного процесса.

Стоимость без автоматизации Формула, используемая для
расчета стоимости возможности
без автоматизации. Формула
используется, чтобы помочь вам на
основе рентабельности инвестиций,
используемых приложений,
количества пользователей и т. д.
решить, какие возможности для
развития вашего бизнеса следует
сделать приоритетными. Формула
рассчитывается путем перемножения
количества пользователей, общей
почасовой оплаты количества
пользователей и среднего цикла
процесса.

Экономия Потенциальная экономия, связанная
с данной возможностью (она может
быть указана как годовая экономия
или экономия за один прогон).

Приоритет Уровень приоритета, присвоенный
возможности. Возможный приоритет.
• Низкий
• Средний
• Высокий

Созданный бот Данный бот создавался для
возможности. Это может быть
«Да» или «Нет». Команда
Преобразовать в бота недоступна
для автоматически генерируемых
возможностей. The Convert to
bot option is available for custom
opportunities only.

c) Выберите нужную возможность в таблице с помощью сортировки, поиска или обоих
вариантов, используя поле Поиск.

d) Чтобы просмотреть возможность или загрузить документ PDD в формате Word или PDF,
щелкните значок вертикального многоточия (три точки) в таблице.
Возможность загрузки PDD в формате Word или PDF доступна только для пользовательских
возможностей.

e) Выберите возможность из таблицы для отображения.
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2. Необязательно: Создайте пользовательскую возможность на основе автоматически
сгенерированной возможности.
a) Разверните раздел Записи в левой части основного холста.

По умолчанию все выбранные записи отображаются на диаграмме процесса.
b) При необходимости выберите запись из раздела Записи для просмотра.

Выбранная запись выделяется синим цветом в разделе Записи и отображается на новом
холсте фидера слева от основного холста. Все записи отображаются на диаграмме процесса
справа от основного холста. Выключите выбранную запись, чтобы выбрать другую запись
для отображения.

c) Чтобы выбрать способ отображения шагов, выберите значок скриншота или значок
приложения.
При необходимости используйте команды Увеличить масштаб или Уменьшить
масштаб. Команда Сброс масштаба используется для возвращения вида к уровню по
умолчанию и изменения положения процесса на холсте.
Непрерывные шаги, выполняемые в одном и том же приложении, объединяются. Они
отображаются как одна группа, чтобы улучшить читаемость процесса. В правом нижнем
углу группы указано количество объединенных шагов.

Прим.:  Если представление скриншота — последнее активное представление, то для
свернутой группы отображается изображение последнего шага в группе. Процесс можно
перетащить в нужное место в пределах холста, удерживая нажатой левую кнопку мыши.

d) Щелкните шаг, чтобы развернуть группу шагов для более детального просмотра шага. Или
щелкните стрелку в правом верхнем углу значка группы.
Значок группы используется для отображения групп шагов, которые относятся к действиям
первичного и вторичного уровня (и действиям уровня подгруппы), выполняемым во время
сеанса записи. При необходимости разворачивайте группу шагов для детализации действий
от первичного уровня до уровня подгрупп, чтобы можно было выбрать группу шагов,
используемую при создании потенциальной возможности для задачи, которую планируется
автоматизировать. Например, действие первичного уровня отображает Microsoft Outlook,
действие вторичного уровня — уведомление о почте Outlook, а действия уровня подгруппы
могут отображать составление сообщения, тело сообщения и отправку сообщения.

e) Установите флажок Выбрать все шаги на панели Обзор, чтобы выбрать все шаги на
диаграмме процесса.
Исходя из своих требований, используйте клавишу Shift, чтобы настроить количество шагов
в пределах пути от основного холста. При выборе вложенной ветви или цикла родительская
ветвь или цикл отображают частичный выбор.

f) Необязательно: Для настройки конкретной возможности используйте Фильтр. Using the
Filter and Toggle frequency counter options.

g) Необязательно: Используйте команду Переключить частотометр для отображения
частоты пути по сравнению с другими записями. Подробнее см. в разделе Using the Filter and
Toggle frequency counter options.

h) Чтобы сохранить возможность как пользовательскую возможность, щелкните Сохранить
как.

i) Введите имя и описание возможности в соответствующие поля.
j) Чтобы сохранить изменения, щелкните Сохранить как.

Открывается окно с сообщением о создании возможности. Щелкните гиперссылку, чтобы
посмотреть пользовательскую возможность. Будет создан документ PDD. Его можно
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загрузить из таблицы Возможности. Щелкните значок с тремя вертикальными точками,
чтобы загрузить PDD в формате Word или PDF.

Прим.:  Опция фильтрации, выбранная для пользовательской возможности, не будет
отражена на диаграмме процесса новой пользовательской возможности.

3. Необязательно: Создайте еще одну пользовательскую возможность на основе этой
пользовательской возможности. Добавьте шаги из другой записи в диаграмму процесса,
создайте ветвь и объедините шаги из одной или нескольких записей в ветвь.
a) Выберите запись из раздела Записи.
b) Щелкните значок ветви на правом основном холсте, чтобы добавить шаг условия.

Перемещение последующего шага в ветвь слева и добавление новой ветви справа в пустую
ветвь служат для получения шагов из другой записи. Чтобы удалить ветвь или создать
новую, щелкните три точки в правом верхнем углу желтого окна. Конечная точка ветви
представлена маленьким кружком.
По умолчанию конечную точку ветви можно переместить ниже по потоку пути, чтобы
включить несколько шагов. Чтобы переместить конечную точку ветви, нажимайте курсором
конечную точку, пока вокруг ветвей не появятся пунктирные линии. Перетащите конечную
точку вниз по потоку пути. Когда между стрелками появятся пунктирные линии, установите
конечную точку. Конечная точка смещается вниз по потоку пути и включает больше
шагов. Чтобы выбрать пользовательский набор шагов, с помощью клавиши Shift выделите
определенное количество шагов в пределах пути на основном холсте. Выбор поперечного
пути недоступен.
Значок цикла отображается в виде оранжевой окружности со стрелкой. Цикл — это
последовательность шагов, которая повторяется определенное количество раз в течение
одной записи. Под значком цикла отображается условие for, а также элемент Count,
который описывает количество повторений в процессе последовательности шагов этого
цикла. Условие цикла (for и while) можно изменить, сохранив диаграмму процесса.

c) Щелкните поле Условие на уровне узлов.
d) В поле Условие введите имя условия. Пример: credit score.
e) Чтобы сохранить имя условия, щелкните галочку.
f) Откройте соответствующие ветви справа и слева и задайте значение условия.

Например, введите «меньше 200» справа и «больше 700» слева.
g) Перетащите шаги из записи на холсте фидера на шаг приемника с записью Перетащите

элементы сюда ветви на основном холсте.
С помощью клавиши Shift выделите один или несколько шагов для перетаскивания на шаг
приемника. Чтобы очистить условие в ветви, щелкните три точки. Выберите Очистить
ветвь.

h) Щелкните Сохранить, чтобы сохранить изменения в диаграмме процесса.
PDD начинает обработку в фоновом режиме автоматически. При создании PDD поле
изменяет значение с «Обработка PDD» на Загрузить.

i) Повторите шаги с «a» по «h», чтобы просмотреть дополнительные записи, создать ветви и
объединить шаги в ветвь.

j) На панели Обзор щелкните значок Редактировать, чтобы обновить возможную экономию,
связанную с пользовательской возможностью.
Возможная экономия и потенциальные затраты могут быть обновлены в любое время
по мере того, как вы просматриваете шаги из различных записей и вносите изменения в
диаграмму процесса.

k) Введите расчетную стоимость процесса без автоматизации.
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l) Введите потенциальную экономию, связанную с процессом при использовании
автоматизации.
Это ваша лучшая оценка ожидаемой ежегодной экономии, если для выполнения всех
действий в рамках этой возможности будет использоваться бот.

m) Выберите приоритет из раскрывающегося списка.
n) Щелкните Обновить.
o) Щелкните Сохранить, чтобы сохранить изменения в диаграмме процесса.
p) Повторите шаги с «j» по «o», чтобы обновить потенциальные затраты для пользовательской

возможности из панели Обзор.
q) Чтобы сохранить возможность как пользовательскую возможность, щелкните Сохранить

как.
r) Введите имя и описание возможности в соответствующие поля.
s) Чтобы сохранить изменения, щелкните Сохранить как.

Открывается окно с сообщением о создании возможности. Щелкните гиперссылку, чтобы
посмотреть пользовательскую возможность.

t) Необязательно: При необходимости повторите шаги с «4a» по «s» для создания другой
пользовательской возможности на основе этой пользовательской возможности.
Все возможности (автосгенерированные и пользовательские) можно посмотреть на
странице Возможности.

4. Необязательно: Для пользовательских возможностей просмотрите новые записи, отправленные
пользователем Discovery Bot. Примите или отклоните новые изменения для диаграммы
процесса.
a) Щелкните Просмотр, чтобы принять обновления и просмотреть новые записи.
b) Выберите новую запись в разделе Записи.

Выбранная запись выделяется синим цветом. Отображение записи открывается слева
от холста. Обратите внимание на пунктирные линии вокруг шагов. Расположение шагов
отображается в диаграмме процесса справа от холста с жирной рамкой вокруг шагов. The
shaded green refers to the placement of the groups of steps from the new recording as they will
appear in the process diagram if you update with these changes.

c) Чтобы принять обновления диаграммы процесса, щелкните Обновить с изменениями.
Отображается всплывающее сообщение, указывающее на успешное обновление с учетом
изменений.

d) Чтобы вернуться к текущей диаграмме процесса без внесения изменений, щелкните
Вернуться к редактированию.

e) Чтобы отменить изменения, щелкните Отклонить.
Продолжайте просматривать текущую диаграмму процесса для пользовательской
возможности. При необходимости добавьте шаги из другой записи в диаграмму процесса,
создайте ветвь и объедините шаги из одной или нескольких записей в ветвь.
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5. Преобразование в бот.
a) Щелкните команду Преобразовать в бота.
b) Введите имя бот.
c) Необязательно: Введите описание.
d) Щелкните Обзор и примите расположение папки по умолчанию: \Bots\.

Чтобы изменить место хранения бот, перейдите в папку, в которой требуется сохранить бот.
e) Щелкните Подтвердить.
f) Щелкните Преобразовать.

Появляется окно с сообщением о том, что бот начал преобразование. После успешного
преобразования бота вы получите электронное сообщение. По гиперссылке в сообщении
перейдите в папку, в которой был создан бот.

Прим.:  На вкладке Мои боты для преобразованного бот отображается ошибка с размером
0 байт, в то время как создание бот находится в процессе. Не открывайте бот, пока не
будет завершено преобразование бот.

Команда Преобразовать в бота доступна только пари наличии лицензии Bot Creator. Для
просмотра созданного бота требуется роль AAE_Basic.

6. Чтобы экспортировать данные о возможности в документ определения процесса (PDD) с тем
же именем, что и возможность, щелкните Загрузить. Выберите тип документа PDD (Word
или PDF), который требуется экспортировать. Документ PDD включает в себя блок-схему
записи процесса с URL-ссылкой на диаграмму процесса внутри Discovery Bot и время на каждом
отдельном этапе в часах, минутах и секундах. The PDD does not display the process diagram if
there are more than 100 steps selected.
Когда создается возможность, PDD автоматически начинает обработку в фоновом режиме.
При создании PDD поле изменяет значение с «Обработка PDD» на Загрузить. Теперь вы
можете загрузить данный документ. Также бизнес-пользователю на указанный в файле адрес
электронной почты отправляется уведомление. Если при загрузке PDD возникла ошибка,
щелкните кнопку Загрузить еще раз, чтобы снова сгенерировать PDD.

Прим.:  Пользователи с несколькими функциями получают по электронной почте два
уведомления для экспортированных данных: одно для данных записи и одно для данных
возможностей.

Прим.:  Загрузить возможность может только ее владелец. Другим загрузка возможности
недоступна.

На вашем компьютере документ сохраняется в папке, настроенной в браузере для загрузок.

Using the Filter and Toggle frequency counter options
Use the Filter and Toggle frequency counter options from the toolbar to help you review, analyze, and
compare the various recordings in the process work flow as you look to create a potential opportunity.

Filter option

Use the Filter option when you want to use a set of values to compare the different sections of a process
across various recordings by selecting a specific path and step filter. The Filter window displays the
following:
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Вариант Действие

Path: С наиболее распространенным потоком Select this option when you want to see what
paths have the most common variance of a
process that is being used. If you choose to
automate this type of path, you will have a
higher return on your investment.

Path: С наибольшими отклонениями Select this option when you want to see certain
sections of the process that have a different
deviation in the path. The automation priority for
such paths are usually low.

Path: С наиболее повторяющимся потоком Select this option when you want to display
sections of the process that are more repetitive
and cost more. The automation priority for such
paths are usually high.

Step: Приложение Select the Application option when you
want to see the application type used during
the recording. Use this option to see which
applications are more frequently used, and to
decide on which applications should be a priority.

Step: Action Type Select the Action type option to filter the
process steps to display only particular actions
that will help you get an idea how the steps are
used.

Очистить Select Clear to clear all selected options.

Сброс Select Reset to reset to the previous saved state
of the filters in a view.

Применить Select Apply to apply the selected options for
display for the system generated or manual
opportunity.

Переключить частотометр

Use the toggle frequency counter option to display the number of recordings that a particular path takes
in the flow for a system generated or manual opportunity. Use this option to help you understand the
frequency of the path as compared to other recordings. From the Recordings table, select two or more
recordings and the Toggle frequency counter displays two at the start of the process flow to indicate
the number of recordings selected. If each recording takes a different path, the process flow is divided
between the total number of recordings selected and displays accordingly. For example, if there are ten
recordings in a view and three paths displayed. Two recordings follow one path, two recordings follow the
second path, and six recordings follow the third path. Along the path flow, you will see two, two, and six.
If a step is merged, the number gets added between the two paths. Use the thick or thinness of the path
to help you prioritize processes for automation. The most commonly used path is the thickest path and this
can be useful for prioritizing a process when reviewing many recordings. For example, if there are 5 paths
for 20 recordings, you will quickly see which is the thickest and consider automating this path. If you have
additional bandwidth to automate another path, you can drill down in the flow and look at the numbers to
see what path is next as a possible candidate for automation.
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Preprocessing error messages
If you encounter any preprocessing errors, review the cause and perform the required action to resolve the
error.
If you build a бот that has more than 2000 lines of code, and if descendant actions like Loop > Continue
or Break actions are used in the бот, it can cause pre-processing errors. To prevent such pre-processing
failures, we recommend that you break the larger бот into smaller боты, and use the Task Bot > Run
action to run from any other бот.

Прим.:
• From Automation 360 v.23, if an error occurs when you run a бот, a preprocessing or runtime error

is shown. Note that preprocessing of child боты does not occur in sequence because these боты are
referred in the parent бот and are sometimes in complex nested workflows. Therefore, the errors might
be displayed in any sequence for these child боты. The parent бот cannot proceed further until all the
errors in the child боты are resolved.

• The following scenarios are applicable only to Automation 360 v.21 or earlier releases. For v.22, Only
the Catch action scenario is applicable, so review the probable cause.

Причина Требуется действие

A mismatch occurred and we did not find the
expected variable data type.

Use an inline expression or a separate action to
convert to the correct variable data type.
Variables overview

A "$" is being read as a variable but no such
variable exists.

Use "$$" to escape the dollar sign and try again.

The бот is calling another бот, but we did not
find the child бот at the specified location.

Check the path and try again.

We found a Catch action that is not contained by
a Try action.

Ensure that each Catch action is contained by a
Try action.

We found a Try action that does not contain a
Catch action. Each Try action requires at least
one Catch action inside it.

Ensure that each Try action contains a Catch
action.

Build advanced боты and packages
Learn how to build action packages and advanced боты that include custom features such as scripting, and
API calls. Find recommendations on бот and action package design and reusability.

More resources

On the Developer portal, find additional how-to tutorials on building advanced боты and пакеты.

SDK для пакетов
SDK для пакетов позволяет создавать и загружать пакеты действий в Control Room.
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В комплекте для разработки пакетов Automation Anywhere содержатся подробные инструкции для
пользователей по самостоятельной разработке пользовательских действий и загрузке пакетов в
Control Room. Пользовательские действия создаются в IDE и компилируются для создания файлов
Java Archive (JAR). Затем JAR-файлы загружаются в Control Room, которая становится доступной в
виде действий на Панели действий.

В разделе «SDK для пакетов» содержатся образцы кодов и вспомогательные файлы для
разработчиков Java, которые позволяют создавать и валидировать пользовательские действия.

November 2022, Release (Automation 360 v.27) A360-package-sdk-2.6.1.zip

June 2022, Release (Automation 360 v.25) A360-package-sdk-2.5.0.zip

December 2021, Release (Automation 360 v.23) A360-package-sdk-2.4.1.zip

September 2021, Release (Automation 360 v.22) A360-package-sdk-2.3.0.zip

June 2021, Release (Automation 360 v.21) A2019-package-sdk-2.1.0.zip

April 2021, Release (A2019.20) A2019-package-sdk-2.0.9.zip

February 2021, Release (A2019.19) A2019-package-sdk-2.0.8.zip

January 2021, Release (A2019.18) A2019-package-sdk-2.0.7.zip

November 2020, Release (A2019.17) A2019-package-sdk-2.0.6.zip

September 2020, Release (A2019.16) A2019-package-sdk-2.0.5.zip

August 2020, Release (A2019.15) A2019-package-sdk-2.0.4.zip

July 2020, Release (A2019.14) A2019-package-sdk-2.0.3.zip

May 2020, Release (A2019.13) A2019-package-sdk-2.0.2.zip

April 2020, Release (2019.12.1) A2019-package-sdk-2.0.1.zip

April 2020, Release (2019.12) A2019-package-sdk-2.0.0.zip

March 2020, Release (2019.11) A2019-package-sdk-1.0.11.zip
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February 2020, Release (A2019.10) A2019.10-package-sdk-1.0.0.zip

January 2020, Release (A2019.09) • Демонстрационный пакет SDK: A2019.09-
packageSDK-1.0.0.zip

• Документация: A2019.09-package-annotations-
javadoc.zip

November 2019 Release (A2019.08) • Демонстрационный пакет SDK: A2019.08-
packageSDK-1.0.0.zip

• Документация: A2019.08-package-annotqations-
javadoc.zip

October 2019 Release (A2019.07) • Демонстрационный пакет SDK: A2019.07-
Package-Sdk-1.0.0.zip

• Документация: A2019.07-package-annotations-
javadoc.zip

Подробные заметки о выпуске «SDK для пакетов» см. в разделе «Automation 360 Package SDK Release
Notes».
Чтобы ознакомиться с подробной информацией о каждой задаче в процессе, щелкните заголовок.

Set up the Java project Set up an integrated development environment
(IDE) for Java, including Automation Anywhere
custom annotations to develop an action package
that you can upload to your Control Room.

Standard coding practices and guidelines for developing
packages

This topic covers standard coding practices and
guidelines that help to ensure the development of
high quality packages.

Develop a sample package Develop your own package and upload it to an
Control Room to provide custom actions for ботs.

How to examples This section contains code examples and
explanations about how to code some basic бот
capabilities.

Annotations This section provides reference information
about the annotations used to create Automation
Anywhere packages.

Build and test a demo package and бот This practical how to section demonstrates that
creating, changing, and managing packages allow
you to customize actions and efficiently manage
packages for all Control Room users.

Build and test a custom package Для создания пользовательского пакета
используйте IntelliJ, а для тестирования пакета
используйте действия Automation 360.

Ссылки, связанные с данной
Automation 360 Package SDK Release Notes
Review the new, changed, fixed, and deprecated features, and security fixes, known issues, and limitations
for the Automation 360 (formerly Enterprise A2019) Package SDK.
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Set up the Java project
Set up an integrated development environment (IDE) for Java, including Automation Anywhere custom
annotations to develop an action package that you can upload to your Control Room.
A working knowledge of Java and Gradle is required in order to successfully build an action package. You
require the following software and file:
• Java Developer Kit (JDK) 11
• Java IDE

• Eclipse
• Community edition of IntelliJ

• Gradle plug-in v.5.*.* in the IDE
• Automation Anywhere Bot Agent installed and connected to your Control Room Download and

extract a zip file
Download and extract the zip file for the release you want:

November 2022, Release (Automation 360 v.27) A360-package-sdk-2.6.1.zip

June 2022, Release (Automation 360 v.25) A360-package-sdk-2.5.0.zip

December 2021, Release (Automation 360 v.23) A360-package-sdk-2.4.1.zip

September 2021, Release (Automation 360 v.22) A360-package-sdk-2.3.0.zip

June 2021, Release (Automation 360 v.21) A2019-package-sdk-2.1.0.zip

April 2021, Release (A2019.20) A2019-package-sdk-2.0.9.zip

February 2021, Release (A2019.19) A2019-package-sdk-2.0.8.zip

January 2021, Release (A2019.18) A2019-package-sdk-2.0.7.zip

November 2020, Release (A2019.17) A2019-package-sdk-2.0.6.zip

September 2020, Release (A2019.16) A2019-package-sdk-2.0.5.zip

August 2020, Release (A2019.15) A2019-package-sdk-2.0.4.zip

July 2020, Release (A2019.14) A2019-package-sdk-2.0.3.zip

May 2020, Release (A2019.13) A2019-package-sdk-2.0.2.zip

April 2020, Release (2019.12.1) A2019-package-sdk-2.0.1.zip

April 2020, Release (2019.12) A2019-package-sdk-2.0.0.zip

March 2020, Release (2019.11) A2019-package-sdk-1.0.11.zip

February 2020, Release (A2019.10) A2019.10-package-sdk-1.0.0.zip

January 2020, Release (A2019.09) • Демонстрационный пакет SDK: A2019.09-
packageSDK-1.0.0.zip

• Документация: A2019.09-package-annotations-
javadoc.zip

November 2019 Release (A2019.08) • Демонстрационный пакет SDK: A2019.08-
packageSDK-1.0.0.zip
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• Документация: A2019.08-package-annotqations-
javadoc.zip

October 2019 Release (A2019.07) • Демонстрационный пакет SDK: A2019.07-
Package-Sdk-1.0.0.zip

• Документация: A2019.07-package-annotations-
javadoc.zip

Configure the build files, compile the JAR file, add the package to your Control Room, and then build a bot
to test your package. Build and test a demo package and бот.
Понятия, связанные с данным
Standard coding practices and guidelines for developing packages
This topic covers standard coding practices and guidelines that help to ensure the development of high
quality packages.
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.
Annotations
This section provides reference information about the annotations used to create Automation Anywhere
packages.
Build and test a demo package and бот
This practical how to section demonstrates that creating, changing, and managing packages allow you to
customize actions and efficiently manage packages for all Control Room users.
Задачи, связанные с данной
Develop a sample package
Develop your own package and upload it to an Control Room to provide custom actions for ботs.

Standard coding practices and guidelines for developing packages
This topic covers standard coding practices and guidelines that help to ensure the development of high
quality packages.

Testing Ensure high quality code. Write sufficient unit tests
and integration tests for your package.

Icons Set proper icon for your package.
Setting the version manually The SDK package build version gets updated

automatically every time a build happens. However,
you can set it manually in the command project of a
common build.gradle file.
• Update the build.gradle file before a build.
• Enter up to four digits numbers, separated my a

period, as shown below:

. . .
ext {
    version '2.0.8'
}
dependencies {...}
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Зависимости Embed all the dependencies in your package JAR.
Load the dependencies at run time by extracting
them to a temporary location. Be sure to clean
the temporary location after the dependencies are
loaded.

Dependent JAR files Add dependent JAR files under dependencies in the
build.gradle file as implementation so that the
dependant JAR files are packaged.

 
. . .
dependencies {
  compileOnly name: 'command-
annotations'
  compileOnly name: 'bot-runtime'
  compileOnly name: 'bot-api'
  implementation name: 'i18n-api'
              implementation name:
 'mydependentjavafile.jar'
  apt name: 'command-processor'
  compileOnly group:
 'org.apache.logging.log4j',
 name: 'log4j-core', version:
 "$loggerVersion"
  testImplementation
 "org.testng:testng:$testNgVersion"
  testImplementation name: 'bot-
runtime'
  testImplementation name: 'bot-api'
 }
. . . 

Add new actions to the exiting package When adding new actions to an existing package,
make sure to do clean before packaging. It
is always a good practice to do clean build -
gradlew.bat clean build shadowJar.

Сообщения об ошибке Provide meaningful error messages.
• Do throw meaningful error messages.

For example, in local language using i18n
APIs with BotCommandException,
throw a new exception
BotCommandException(MESSAGES.getString("Run.Exception.InvalidWorkingDirPath")).

• Do not throw generic error messages, such as
ex.message.

Basic validation Use the validation annotation rules, such as
@NotEmpty included with this development kit. Do
not add basic validations for your code. См. раздел
Validation annotations.

Loops Avoid long running loops in your code. Long
running loops can cause high CPU usage, leading to
errors such as, "Bot is unresponsive."

Add logging Use the default log4J logger provided in the bot
run time framework. Do not add your own logger.
See the sample code for details.
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Logging levels • ERROR/FATAL: Severe error event that the
user is affected and there is no workaround.

• WARN : Unexpected error occurred but the
system has recovered from it.

• INFO: Informational messages about state
change, for example, an accepted request.

• DEBUG: Detailed diagnostic information that
will be required to debug when something goes
wrong.

• TRACE: All information is captured about an
application behavior.
If you are not sure of the log level, set it to
TRACE.

Loading resources All resources should be loaded using current thread
context class loader, as shown in the following
example:

Thread.currentThread().getContextClassLoader().getResourceAsStream("resource.json");

Понятия, связанные с данным
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.
Annotations
This section provides reference information about the annotations used to create Automation Anywhere
packages.
Задачи, связанные с данной
Set up the Java project
Set up an integrated development environment (IDE) for Java, including Automation Anywhere custom
annotations to develop an action package that you can upload to your Control Room.
Develop a sample package
Develop your own package and upload it to an Control Room to provide custom actions for ботs.

Develop a sample package
Develop your own package and upload it to an Control Room to provide custom actions for ботs.
Download and extract the contents from the latest Automation 360 Package SDK release. The newest
package contains the necessary sample source code to build your package.
You need to have a project created in a Java IDE. For details about setting up a project, read Set up the
Java project.
The following high-level tasks provide the basic workflow for creating a package.
1. Create a java class.

This class is the action you plan to publish in your package.

Важное замечание:  It is required that the class supports the default constructor.
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2. Add required business logic to the class.
The following are the supported return types:
• Void: Use this return type if your action does not return any value.
• Значение: Use this return type if your action returns any type of value.

3. Annotate the class with BotCommand and CommandPkg Annotations to make the class eligible to be
converted to an action.

4. Annotate the variable that accepts values with Idx and Pkg.
5. Annotate the entry method with the Execute annotation.
6. From the action prompt, run gradlew.bat clean build shadowJar.

The JAR file created from the build is located in build/lib.

From the Control Room on the Bots > Package page, click the Add package icon to upload the JAR file.

Совет:  To upload a package to a Control Room, you need Upload package permission. Review how to
add a package to an Control Room: Add пакеты to the Control Room.

Понятия, связанные с данным
Standard coding practices and guidelines for developing packages
This topic covers standard coding practices and guidelines that help to ensure the development of high
quality packages.
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.
Annotations
This section provides reference information about the annotations used to create Automation Anywhere
packages.
Задачи, связанные с данной
Set up the Java project
Set up an integrated development environment (IDE) for Java, including Automation Anywhere custom
annotations to develop an action package that you can upload to your Control Room.

Using the package SDK
These example topics provide a basic understanding of how to use the Package SDK with Automation 360.
Each SDK package includes a collection of configurable files that you can use to build a custom package,
and then use the package to create TaskBots.
Use the following steps to create, configure, and build an IntelliJ project to compile a new package, and
then create a бот to test the package you created.
1. Download, extract, and review the Package SDK files:

• Download the latest Automation Anywhere A2019 Package SDK.
Enterprise Automation360 Package Development Kit Release Notes

• Go to your Downloads folder, right-click your downloaded Package SDK, and select Extract All.
• Review all the files included in the package. You can drop any java file in your IntelliJ project to

view or edit the content.
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2. Install the latest Automation 360 version:
a) After the installation, log in to the Control Room with an admin privilege and create a new user

with permissions to upload a package and create боты.
Create a user

b) Connect your local device to the Control Room. If required, download and install the latest Bot
Agent.
Установка Bot Agent и регистрация устройств

3. Install Java SE Development Kit 11 or IntelliJ IDE Community Edition and Gradle plug-in.
• Java SE Development Kit 11 (https://www.oracle.com/java/technologies/javase/jdk11-archive-

downloads.html)
• Java IDE (https://www.jetbrains.com/idea/download/#section=windows)

4. Configure the sample build files in the IntelliJ project.
Configuring build files

5. Create a new directory, package, and class.
Creating new Java class

6. Use the compiled JAR file as a package and upload it to your Control Room in Automation 360.
Upload custom package to your Control Room

7. Create a TaskBot to test the new package.
Create a бот to test the new package

8. Необязательно: Verify the results, and if required, add additional actions to your bot flow, and
configure parameters and values.

9. View additional resources.
To learn more, search for the Package SDK: How to examples.

Configuring build files

Configuring build files
Use IntelliJ to configure and compile a JAR file, and then upload it as a package to your Control Room in
Automation 360.
A basic understanding of JDK and Java IntelliJ is required in order to build an action package. Ensure you
have the following software and files:
• Java SE Development Kit 11 (https://www.oracle.com/java/technologies/javase/jdk11-archive-downloads.html)
• Java IDE (https://www.jetbrains.com/idea/download/#section=windows)
• Automation Anywhere A2019 SDK. Download and extract the zip file for the release you require:

Enterprise A2019 Package Development Kit Release Notes

1. Unzip the contents of the SDK package to your IdeaProjects directory and rename the folder from
<latest package sdk zip file> to A2019FileDetails.

2. In IntelliJ IDEA, go to File > Open and open the project located at C:\Users\<User>
\IdeaProjects\A2019FileDetails.

3. Open the settings.gradle file in the project root, and set the rootProject.name =
 'A2019FileDetails'

4. Update the package.template file located at src > main > resources > package.template.
5. Change the package name from A2019DemoPackage to A2019FileDetails.
6. Update the package name in locales json: go to src > main > resources > locales >

en_US.json.
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a) Open the en_US.json file and update the required label field. Update the optional
description.

b) Delete all other remaining lines in the en_US.json file.

7. Open the build.gradle in the project root. After the dependencies section, remove other
dependencies, if they are not required.

8. Save all files.

Creating new Java class

Creating new Java class
Use IntelliJ to create a new java class and a new directory, and configure other build files.
Complete the steps in the following task: Configuring build files.
1. Create a new Java Class, right-click the com.automationanywhere.botcommand package, and

select New > Java Class. Enter the name for the new class GetFileDetails.
a) Copy @BotCommand from the Concatenate. java and paste it into the new

GetFileDetails.java file.

import static com.automationanywhere.commandsdk.model.DataType.STRING;
//BotCommand makes a class eligible for being considered as an action.

@BotCommand
//CommandPks adds required information to be dispalable on GUI.
@CommandPkg(
  //Unique name inside a package and label to display.
  name = "concatenate", label = "[[Concatenate.label]]", 
  node_label = "[[Concatenate.node_label]]", description =
 "[[Concatenate.description]]", icon = "pkg.svg", 
  
  //Return type information. return_type ensures only the right kind
 of variable is provided on the UI. 
  return_label = "[[Concatenate.return_label]]", return_type = STRING,
 return_required = true)
public class Concatenate {
 
 //Messages read from full qualified property file name and provide
 i18n capability.
 private static final Messages MESSAGES = MessagesFactory
   .getMessages("com.automationanywhere.botcommand.samples.messages");

 //Identify the entry point for the action. Returns a Value<String>
 because the return type is String. 
 @Execute
 public Value<String> action(
   //Idx 1 would be displayed first, with a text box for entering the
 value.
   @Idx(index = "1", type = TEXT) 
   //UI labels.
   @Pkg(label = "[[Concatenate.firstString.label]]") 
   //Ensure that a validation error is thrown when the value is null.
   @NotEmpty 
   String firstString,
   
   @Idx(index = "2", type = TEXT) 
   @Pkg(label = "[[Concatenate.secondString.label]]") 
   @NotEmpty 
   String secondString) {
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  //Internal validation, to disallow empty strings. No null check
 needed as we have NotEmpty on firstString.
  if ("".equals(firstString.trim()))
   throw new
 BotCommandException(MESSAGES.getString("emptyInputString",
 "firstString"));

  if ("".equals(secondString.trim()))
   throw new
 BotCommandException(MESSAGES.getString("emptyInputString",
 "secondString"));

  //Business logic
  String result = firstString + secondString;
  
  //Return StringValue.
  return new StringValue(result);

b) Update the @CommandPkg parameters such as: name, label, node_label, description,
and icon.

c) Update the return_label and the return_type.
d) Add the NumberValue action, internal validation, business logic, and the return value.
e) Delete the Concatenated. java file and samples.commands. basic directory, and the

sample.commands directory.

2. Configure the en_US.json file: go to src > main > resources > locales > en_US.json and add
the following fields after the label and description values, and delete other parameters from the file.

{
 "label": "File Details",
 "description": "Returns basic file details",
 "GetFileDetails.label": "File Size",
 "GetFileDetails.description": "Return the size of the selected file in
 bytes",
 "GetFileDetails.node_label": "File Size in Bytes",
 "GetFileDetails.return_label": "File Size",
 "GetFileDetails.return_label_description": "Return in bytes",
 "GetFileDetails.filePath.label": "Select a File for analysis"
}

3. Delete packages: go to src > main > java > com.automationanyhwere.botcommand, and
delete the samples.commands and delete the samples packages.

4. Import new icons from Github and update the CommandPkg annotation.
a) Download any icons you want to use in your bot flow and save them as .svg files.
b) Copy your image files into the src > main > resources > icons folder.

5. Create a new directory: go to src, right- click, and select New > Directory.
a) In the Name field, enter test\java. Alternatively, select the test\java, and enter the name

TestFileSize.
b) Configure test annotations in the TestFileSize java class.
c) Create a @test public class, create a GetFileDetails object, and invoke the action.
d) Необязательно: Run the TestGetFileDetails in IntelliJ to test it.
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6. Configure the TestFileSize file, and open TestFileSize and copy and paste the following code:

{
    @Test
    public void TestGetFileDetails() {
        String filePath = "src\\main\\resources\\icons\\sample.svg";
        //Create GetFileDetails Object
        GetFileDetails getFileDetails = new GetFileDetails();
        //invoke action
        NumberValue output = getFileDetails.action(filePath);
        Assert.assertEquals(output.getAsDouble(), 5027.0);
    }

7. Save the project: File > Save All.
8. Click Reload All Gradle Projects, and then click Execute Gradle Task, and verify that the

A2019FileDetails project is selected.
9. In the Run Anything window, enter gradle clean build shadowJar.

After it runs, the following message is displayed: BUILD SUCCESSFUL in 8s <number of seconds>

Upload custom package to your Control Room

Upload custom package to your Control Room
Use the compiled JAR file and upload it as a package to your Control Room in Automation 360.
• Complete the steps in the following task: Creating new Java class.
• Ensure you have the following:

• Access to the Control Room.
• Credentials with AAE_Basic permission or a custom role with the capability to upload packages to

the Control Room.

1. From Windows Explorer, go to C:\Users\<Username>\IdeaProjects\A2019-FileDetails
\build\libs and locate A2019FileDetails-2.0.9.jar.

2. Log in to your Control Room as a user with permissions to add a new package.
3. Click BOTS > Packages.
4. In the All packages page, move your mouse over the plus sign and click Add package.
5. In the Add package page, click Browse and locate the A2019FileDetails-2.0.9.jar file.

By default, the file is located at: C:\Users\<Username>\IdeaProjects\A2019-FileDetails
\build\libs.

6. Select the A2019FileDetails-2.0.9.jar file and click Open.
7. Click Upload Package.

When you upload a custom package to the Control Room, a notification is also sent to the Control
Room users to notify about package updates. This notification is sent to the users who have the View
package permission. For more information, see Add or update пакет event notification.

Create a бот to test the new package

Create a бот to test the new package
Use the actions in Automation 360 to create a бот and test the new package you have added to your
Control Room.
Ensure you have the following to build the бот:
• Access to the Control Room.
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• Credentials with AAE_Basic permission or a custom role to create боты.
• Your workstation is a registered device in the Control Room.
• Your package A2019FileDetails-2.0.9.jar is available in the Control Room.

1. Войдите в Control Room.
2. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
3. Click the Create a bot icon.
4. In the Name field, enter TestingFileSize or any other name you want.
5. Click Create & Edit.
6. In the Actions pane, find File Details and drag File Size into the бот flow.

a) In the Select a File for analysis field, select Desktop file, click Browse, and select any file
from your desktop.

b) Click Create variable to create a new number variable.
c) In Create Variable, enter nFileSize and click Create & Select.
d) Щелкните Применить.

7. In the Actions pane, find the Number package and drag the To String command.
a) In the Enter a number field, enter F2, and select nFileSize.
b) In the Assign the output to variable field, select prompt-assignment - String from the

drop-down list.
c) Щелкните Применить.

8. From the Actions pane, drag Message box.
9. In the Enter the message to display field, click F2 and select the prompt-assignment variable.
10. Click Apply and Save.
11. Click Run.

The бот displays the <The value of the file size> , which is a successful build.

If you were not able to run ботyour bot, go back and modify your configuration steps in your Control
Room.

How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.

Return a value from an action Set the following properties on CommandPkg to
store the action output in a variable.

Expose property attributes of action The property values of an action can be exposed by
setting the following properties on CommandPkg.

Organize and group actions when developing packages Review the provided examples on how to add and
group actions during the package SDK development
process.

Input types - UI elements The user interface (UI) elements are the input
controls used to receive inputs in an action while
building a bot.

Create custom variables using Package SDK When using Automation 360, you can create
custom variables using the SDK package.
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Create a condition using Package SDK When using Automation 360, you can create a
condition with the SDK package.

Add a condition in a custom package for If condition Add conditions in a custom package.
Create an iterator using Package SDK In Automation 360, you can create an iterator

with the SDK package. An iterator is used to loop
through multiple objects of similar type and is used
with the Цикл package. It consists of two methods,
next and hasNext, which return the actual object
and a boolean value.

Create a trigger using Package SDK When using Automation 360, you can create a
trigger using the SDK package.

Custom triggers - pull and push mechanism The examples provided in this topic demonstrate
how to create time-based and event-based
triggers, pull (link TriggerDemo) and push
(SimpleMessageListenerContainer)
mechanisms using the SDK package.

Add debug logs of custom packages to bot_launcher.log
file

You can add logs using log4j. The dependency
is already added in the package SDK sample
build.gradle file.

Handle sessions in a custom package You can extract a session using a session name
from the SessionsMap. In the same package, you
can use sessions to pass information between
actions, but not to other packages.

Configure shared session using Package SDK Package SDK provides configuration for the SDK
users to create and use shared sessions. Sessions
are seamlessly shared between different bots to
share resources between them. This means that if
a session has been created, the other TaskBots can
read and update the session and vice versa.

Create a бот to test the custom package A shared session enables you to reuse actions
between TaskBots that run concurrently, for
example, using the same Excel file to pass values.

Actions
Any action class supports only one method as an entry point. Annotate all parameters of the entry point
method with Idx. There are three types of actions:
• Command\Action (default choice)
• Итератор
• Условие

Важное замечание:  If you do not provide a public setter to member variables with Inject,
compilation errors occur.

Понятия, связанные с данным
Standard coding practices and guidelines for developing packages
This topic covers standard coding practices and guidelines that help to ensure the development of high
quality packages.
Annotations
This section provides reference information about the annotations used to create Automation Anywhere
packages.
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Задачи, связанные с данной
Set up the Java project
Set up an integrated development environment (IDE) for Java, including Automation Anywhere custom
annotations to develop an action package that you can upload to your Control Room.
Develop a sample package
Develop your own package and upload it to an Control Room to provide custom actions for ботs.

Return a value from an action
Set the following properties on CommandPkg to store the action output in a variable.

Action return values

• return_type
Defines the return type of the action. It usually matches the entry method return type.

• return_required
When the value is set to true the return value is required.

• return_label
A description of the UI label for the variable value.

Пример. Convert a sourceString to uppercase and assign the result to
returnTo

//BotCommand makes a class eligible for being considered as an action.
@BotCommand

//CommandPks adds required information to be displayable on the UI.
@CommandPkg(
  //Unique name inside a package and label to display.
  name = "uppercase", label = "[[Uppercase.label]]",  
  node_label = "[[Uppercase.node_label]]",  description =
 "[[Uppercase.description]]", icon = "pkg.svg", 
  
  //Return type information. return_type ensures only the right kind of
 variable is provided on the UI. 
  return_label = "[[Uppercase.return_label]]", return_type =
 STRING, return_required = true)
public class Uppercase {
 
 //Messages read from a fully qualified property file name and provides i18n
 capability.
 private static final Messages MESSAGES = MessagesFactory
   .getMessages("com.automationanywhere.botcommand.samples.messages");

 //Identify the entry point for the action. Returns a Value <String> because
 the return type is String. 
 @Execute
 public Value<String> action(
   //Idx 1 would be displayed first, with a text box for entering the value.
   @Idx(index = "1", type = TEXT) 
   //UI labels.
   @Pkg(label = "[[Uppercase.sourceString.label]]") 
   //Ensure that a validation error is thrown when the value is null.
   @NotEmpty 
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   String sourceString,

Понятия, связанные с данным
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.

Expose property attributes of action
The property values of an action can be exposed by setting the following properties on CommandPkg.

Действие property values

Property Attributes Описание

property_name The name of the property, unique at action level, in auto-
complete box this name would appear.

property_description A description of the property.

property_type The data type on which property operates, only if the type
matches, the property will be appear in the auto-complete
box.

property_return_type The data type for what property returns. If this type does
not match with the field type where it is used, there will be
validation error.

@BotCommand
@CommandPkg(label = "Uppercase", name = "uppercase", description="Converts
 the string to upper case", 
icon = "uppercase.svg", node_label="Convert {{sourceString}} to upper case|
 and assign the result to {{returnTo}}|", 
return_type=DataType.STRING, return_required = true, return_label="Assign
 the output to variable", 
property_name="uppercase", property_description="Converts the string to
 upper case", property_type=DataType.STRING, 
property_return_type=DataType.STRING) public class UpperCase {
 
    @Execute
    public Value<String> convert(
            @Idx(index = "1", type=TEXT)
            @Pkg(label="Source string")
            @NotEmpty
            String sourceString){
        return new StringValue(sourceString.toUpperCase());
    }
}

For example, the above class in the UI will look like:
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Понятия, связанные с данным
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.

Organize and group actions when developing packages
Review the provided examples on how to add and group actions during the package SDK development
process.
Пример. Addactions

@BotCommand

//CommandPks adds required information to be dispalable on the UI.
@CommandPkg(
  //Unique name inside a package and a label to display.
  name = "concatenate", label = "[[Concatenate.label]]", 
  node_label = "[[Concatenate.node_label]]", description =
 "[[Concatenate.description]]", icon = "pkg.svg", 
  
  //Return type information. return_type ensures only the right kind of
 variable is provided on the UI. 
  return_label = "[[Concatenate.return_label]]", return_type = STRING,
 return_required = true)

Пример. Groupactions
Use the group_label to ConcatenateGroup which it is displayed in the UI also as
ConcatenateGroup. When the group_label is not used, you will get all the actions in the respective
package.

@BotCommand
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//CommandPks adds required information to be dispalable on the UI.
@CommandPkg(
  //Provide a unique name inside a package and a label to display.
  group_label = "ConcatenateGroup", name = "concatenateWithGroup", label =
 "concatenateWithGroup",
  node_label = "[[Concatenate.node_label]]", description =
 "[[Concatenate.description]]", icon = "pkg.svg", 
  
  //Return type information. return_type ensures only the right kind of
 variable is provided on the UI. 
  return_label = "[[Concatenate.return_label]]", return_type = STRING,
 return_required = true)
public class ConcatenateWithGroup {

Input types - UI elements
The user interface (UI) elements are the input controls used to receive inputs in an action while building a
bot.

The following examples show the supported input types. Use the UI elements to create user interface (UI)
designs to build the Control Room interfaces. For instance, if you need an input as text then, use TEXT, if
you need a radio button, select RADIO, and so on. This topic is based on the SampleUI sample available
within the Package SDK in the following location: <PackageSDK>\src\main\java\com\automationanywhere
\botcommand\samples\commands\ui\SampleUI.java.

1. Make sure you have imported the following packages to ensure all the functionalities works as
described in the sample.

import com.automationanywhere.commandsdk.annotations.Idx;
import com.automationanywhere.commandsdk.annotations.Pkg;
import com.automationanywhere.commandsdk.annotations.rules.CodeType;
import com.automationanywhere.commandsdk.annotations.rules.VariableType;

2. Add the @BotCommand annotation to make a class as an Action in the Control Room. For more
information on annotations, see Annotations.

@BotCommand

3. Add the @CommandPkg annotation to define all the UI related components - labels, description, and
name.

@CommandPkg(label = "UI Demo", description = "Demonstrates the provided
 UI elements", name = "uiDemo")

4. Create a class and define the fields as described below.
a. Annotate the method with @Execute to execute the method during compilation.
b. In this sample, @Idx and @Pkg are used as a member of the class, so you should use set and

get methods to define them.
1. @Idx - Defines the index of an action.
2. @Pkg - Defines all the parameters and member variables shown in the interface. Must be

accompanied by the @Idx, if not this annotation is ignored.
3. @Inject - To receive value from the UI using the member class, @Inject is required at

field levels.

@BotCommand
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@CommandPkg(label = "UI Demo", description = "Demonstrates the
 provided UI elements", name = "uiDemo")
public class SampleUI {
        @Idx(index = "1", type = TEXT)
        @Pkg(label = "Text type")
        @Inject
        String text;

    @Execute
    public String getText() {
        return text; 
    } 
    public void setText(String text)  {
        this.text = text; 
    }
}

5. Drag the action into canvas and you will be able to input a string in the text field. You will see an input
box similar to this image.

UI element - Number field
Use the Number type to create an UI element that will accept a number. Using the below sample you will
be able to create a field that will accept only numbers.

@BotCommand
@CommandPkg(label = "UI Demo", description = "Demonstrates the provided UI
 elements", name = "uiDemo")
public class SampleUI {
        @Idx(index = "2", type = NUMBER)
        @Pkg(label = "Number type")
        @Inject
        String num;

    @Execute
    public String getNum() {
        return num; 
    } 
    public void setNum(String num)  {
        this.num = num; 
    }
}

Other UI elements
It is possible to create other UI components like: Boolean, Radiobutton, Number, Variable, Code, Dictionary,
List, Date/Time, and so on. To get a complete list of UI elements supported, see <PackageSDK>\src\main
\java\com\automationanywhere\botcommand\samples\commands\ui\SampleUI.java.
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UI validations supported
The following UI validations are also supported:
• @NotEmpty means that the UI field needs an input at the bot design time.
• @ LocalFile refers to a local file from a user machine.
• @NumberIntegers refers to a number value that you can provide, such as, a float or a double input kind.

Create custom variables using Package SDK
When using Automation 360, you can create custom variables using the SDK package.

Using custom variables

Use Automation 360 to create a custom variable. This is a system variable and is used as other бот
variables, except it is read-only and the value is calculated instead of being assigned.

Required annotations

For creating a variable, the following annotations are required:

Аннотация Использование

BotCommand Use the BotCommand annotation with the
variable as commandType. This ensures that the
plain old Java object (POJO) is suitable for creating
an Automation 360 variable.

CommandPkg These values are used when creating a package.
Provide a name, label, and description to the
annotation.

Idx Annotate all the parameters and member variables
that are required and help with the validation
check. Alternatively they might be displayed in the
interface for the input. Provide the index (Idx) and
the type.

Pkg Annotate all the parameters and member variables
that will be shown in the interface. This annotation
will be ignored if it is not accompanied by the Idx.

VariableExecute The method that has to be called for returning
the variable value. This method does not
accept any input parameters. Sessions and
GlobalSessionContext are available though
setter injection.

Use case example

The following use case shows how to return the current time for the system default zone.
1. Create the POJO class with the business logic:

public class Now {
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 public DateTimeValue now() {
  Instant instant = Instant.now();
  ZonedDateTime now = instant.atZone(ZoneId.systemDefault());
  return new DateTimeValue(now);
 }

}

2. Annotate the POJO class to enable it for the Automation 360 variable and to create the package:

@BotCommand(commandType = BotCommand.CommandType.Variable)
@CommandPkg(description = "The current datetime at system default zone.",
 name = "Now", label = "", variable_return_type = DataType.DATETIME)
public class Now {
 
 public DateTimeValue now() {
  Instant instant = Instant.now();
  ZonedDateTime now = instant.atZone(ZoneId.systemDefault());
  return new DateTimeValue(now);
 }

}

3. Annotate the now method to denote it to be the execute method.

@VariableExecute
 public DateTimeValue now() {
  Instant instant = Instant.now();
  ZonedDateTime now = instant.atZone(ZoneId.systemDefault());
  return new DateTimeValue(now);
 }

Every variable must have one test VariableExecute method.

Понятия, связанные с данным
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.

Using EntryList
EntryList enables you to accept any number of parameters through the бот designer. The parameter
structure is defined in the Automation 360 actions.

Пример. EntryList

The following example shows how to create a parameter with the name of village pair.

@BotCommand
@CommandPkg(label = "EntryList example", description = "EntryList example",
 icon = "sample.svg", name = "entryListExample")
public class EntryListExample {
 // UI display for ENTRYLIST 1.1, the linking is done based on the ENTRYLIST
 title.
 // This should be added as a child of the ENTRYLIST, however it should not
 be part of options.
 // The EntryList does not need a setter or Inject as the value is provided
 inside the ENTRYLIST.
 @Idx(index = "1.3", type = TEXT, name = "NAME")
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 @Pkg(label = "Name", default_value_type = DataType.STRING)
 @NotEmpty
 private String name;
 //Linked to 1.2 through title.
 @Idx(index = "1.4", type = TEXT, name = "VILLAGE")
 @Pkg(label = "village", default_value_type = STRING)
 private String city;
 @Execute
 public void setParameter(
   // Add the entryList, the values are accepted as a list of values.
   // Provide the column header for the tabular display of accepted entries.
   // In Pkg, provide a unique title.
   // Provide Idx for each option separately, this is needed to
   // have the correct UI type when the entry form is presented.
   // Add only columns to options, you cannot add their definitions.
   @Idx(index = "1", type = ENTRYLIST, options = {
     @Idx.Option(index = "1.1", pkg = @Pkg(title = "NAME", label = "Name")),
     @Idx.Option(index = "1.2", pkg = @Pkg(title = "VILLAGE", label =
 "village")),
   })
   //Label that is desplayed in the UI
   @Pkg(label = "Provide name value entries")
   //Header of the entry form
   @EntryListLabel(value = "Provide entry")
   //Button label which displays the entry form
   @EntryListAddButtonLabel(value = "Add entry")
   //Unique rule for the column, this value is the column TITLE. 
   @EntryListEntryUnique(value = "NAME")
   //Message to dispaly in the table when no entries are present.
   @EntryListEmptyLabel(value = "No parameters added")
     List<Value> entryList) {

 }

Here is another example of the EntryList, define the values of the EntryList usage.

//Entry list//
@Idx(index = "1", type = ENTRYLIST, options = {
      @Idx.Option(index = "1.1", pkg = @Pkg(title = HEADER_ENABLED, label =
 "[[HEADER1]]")),
      @Idx.Option(index = "1.2", pkg = @Pkg(title = HEADER_NAME, label =
 "[[HEADER1]]")),
      @Idx.Option(index = "1.3", pkg = @Pkg(title = HEADER_VALUE, label =
 "[[HEARER3]]"))
})
@Pkg(label = "customHeaderslabel")
@EntryListLabel(value = "customHeaderlabel")
@EntryListAddButtonLabel(value = "add.header")
@EntryListEmptyLabel(value = "no.header")
@Inject
List<Value> customHeaders;

Понятия, связанные с данным
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.

Using regular expression
Use regular expressions (regex) to create string patterns that help match, locate, or manage text in Java.
Together, the literals and special characters define a logical pattern. Use the pattern to compare strings of
text to check if the strings match the defined pattern.
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Прим.:  Regular expression (regex) does not recognize [\b] as a Backspace command. Use \\b to use
Backspace instead.

Пример. MatchesRegex

Use MatchesRegex to test the string pattern.
In the following example, the input pattern starts from the English alphabet, uppercase and lowercase, (A-
Z/a-z) and ends with a numeric value.

@Idx(index = "1", type = TEXT)
@Pkg(label = "Field label", description = "Field description]")
@MatchesRegex("^[A-Za-z]\w*")
@NotEmpty
String cell

If the pattern does not match, the following message is displayed: Must match pattern.
Понятия, связанные с данным
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.

FILE2 (Regex) attribute
A regular expressions (RegEx) are patterns of string defined to search for a file in a specified path. Use the
FILE2 attribute when using regular expressions (regex) to create string patterns.
For instance: If you want to search a folder path for a file (For example Hello.txt)which contains a
certain string. . You will use File2 attribute type to enter the following regex pattern: Hell or ell which
will find the file that matches the search criteria. This topic is based on the File2TypeDemo sample available
within the Package SDK in the following location <PackageSDK>\src\main\java\com\automationanywhere
\botcommand\samples\commands\basic\types\File2TypeDemo.java.

Using the FILE2

1. Make sure you have imported the following packages to ensure all the functionalities works as
described in the sample.

import com.automationanywhere.commandsdk.annotations.*;
import com.automationanywhere.commandsdk.model.AttributeType;
import org.apache.logging.log4j.LogManager;
import org.apache.logging.log4j.Logger;

2. Add the @BotCommand annotation to make a class as an Action in the Control Room. For more
information on annotations, see Annotations.

@BotCommand

© 2023 Automation Anywhere. All rights reserved.     2401



    Automation Anywhere - Сборка

3. Add the @CommandPkg annotation to define all the UI related components - labels, description, icon,
return type, and name.

@CommandPkg(label = "[[File2TypeDemo.label]]", description =
 "[[File2TypeDemo.description]]", icon = "sample.svg", name =
 "file2TypeDemo")

4. Create a method (For example: regexFile) within your class and define the fields as described below.
a. Annotate the method with @Execute to execute the method during compilation.
b. In the below sample, @Idx, @Pkg, and @NotEmpty are defined as a parameters of the method.

If they are used as a member of the class, then you should use set and get methods to define
them.
1. @Idx - Defines the index of an action. (@Idx(index = "1", type =

 AttributeType.FILE2))
2. @Pkg - Defines all the parameters and member variables shown in the interface

(@Pkg(label = "[[File2TypeDemo.localFile.label]]") ). Must be accompanied
by the @Idx, if not this annotation is ignored.

3. @NotEmpty - Defines that this parameter cannot be empty (@NotEmpty @LocalFile
 FileValue fileValue)).

@BotCommand
@CommandPkg(label = "[[File2TypeDemo.label]]",
    description = "[[File2TypeDemo.description]]", icon =
 "sample.svg", name = "file2TypeDemo")
public class File2TypeDemo {
    private static Logger logger =
 LogManager.getLogger(File2TypeDemo.class);

    @Execute
    public void regexFile(
        @Idx(index = "1", type = AttributeType.FILE2) 
        @Pkg(label = "[[File2TypeDemo.localFile.label]]") 
        @NotEmpty @LocalFile FileValue fileValue)

5. Build and upload the custom package to the Control Room. For more information on uploading the
package, see Using the package SDK.

6. Create a bot.
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7. Drag the action into canvas and you will be able to input the regex to find a file. You will see an input
box similar to this image.

Print the Regex - Folder name and the File location
Use the Logger interface obtained from Log4j package to provide information of the objects being
manipulated. In the below sample you will be able to log the folder name and the local file location by using
the debug method.

@BotCommand
@CommandPkg(label = "[[File2TypeDemo.label]]",
  description = "[[File2TypeDemo.description]]", icon = "sample.svg", name =
 "file2TypeDemo")
public class File2TypeDemo {
  private static Logger logger = LogManager.getLogger(File2TypeDemo.class);

  @Execute
  public void regexFile(
    @Idx(index = "1", type = AttributeType.FILE2) @Pkg(label =
 "[[File2TypeDemo.localFile.label]]") @NotEmpty @LocalFile FileValue
 fileValue) {
    if (fileValue.isRegex()) {

      RegexFile regexFile = fileValue.getRegex();
      logger.debug("folder name {}", regexFile.getFolder());
      logger.debug("local file location {}",
 regexFile.getFileNamePattern().toString());
    } else {
      logger.debug("Regex option is not selected");
    }
  }

Create a condition using Package SDK
When using Automation 360, you can create a condition with the SDK package.
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Using a condition

Если and Цикл are branching constructs in Automation 360. They are used to run a sequence of actions
when a condition is set to true. A condition is used along with the Если and Цикл packages. A condition
takes a set of inputs and returns a Boolean value.

Required annotations

For creating a condition, the following annotations are required:

Аннотация Использование

BotCommand Use the BotCommand annotation with the
condition as commandType. This ensures that
the plain old Java object (POJO) is suitable for the
creation of an Automation 360 condition.

CommandPkg These values are used when creating a package.
Provide a name, label, and description to the
annotation.

Idx Annotate all the parameters and member variables
that are required and help with the validation
check, or they might be displayed in the interface
for the input. Provide the index (Idx) and the type.

Pkg Annotate all the parameters and member variables
that will be shown in the interface. This annotation
will be ignored if it is not accompanied by the Idx.

ConditionTest The method that has to be called for testing the
condition. It must return a Boolean value. If the
method accepts parameters, then annotate them
with Idx.

Use case example

The following use case verifies whether the given number is greater than the other number.
1. Create the POJO class with the business logic:

public class IsGreater {

 public Boolean checkGreater(Double first, Double checkAgainst) {
  return first > checkAgainst;
 }

}

2. Annotate the POJO class to enable it for the Automation 360 condition and to create the package:

@BotCommand(commandType = Condition)
@CommandPkg(label = "Is greater condition", name = "IsGreater",
 description = "Checks if the given number is greater than the other.",
 node_label = "{{first}} > {{checkAgainst}} ")
public class IsGreater {
 public Boolean checkGreater(Double first, Double checkAgainst) {
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  return first > checkAgainst;
 }
}

3. Annotate the checkGreater method to indicate that this method should be used as a comparison
method.

@ConditionTest
public Boolean checkGreater(Double first, Double checkAgainst) {
 return first > checkAgainst;
}

Every condition must have exactly one test condition method.
4. Annotate the parameters of the checkGreater method with Idx and Pkg.

Add @NotEmpty to ensure the value is not null.

@ConditionTest
public Boolean checkGreater(
 @Idx(index = "1", type = AttributeType.NUMBER) @Pkg(label = "Number to
 check") @NotEmpty Double first,

 @Idx(index = "2", type = AttributeType.NUMBER) @Pkg(label = "Number to
 compare against") @NotEmpty Double checkAgainst) {

 return first > checkAgainst;
}

The attribute type number returns a Double.

Понятия, связанные с данным
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.

Add a condition in a custom package for If condition
Add conditions in a custom package.

Create condition values in an Действие

• To create a condition, set commandType property of BotCommand annotation with value as
Condition.

• To define the entry method of the condition, use the annotation ConditionTest.

@BotCommand(commandType = Condition)
@CommandPkg(label = "File exists", name = "fileExists",
        description = "Checks if the file exists.",
        node_label = "file exists at {{sourceFilePath}}", icon = "")
public class Exist extends AbstractCondition {
    @ConditionTest
    public boolean test(@Idx(index = "1", type = FILE) @LocalFile @Pkg(label
 = "File path") @NotEmpty String sourceFilePath,
                        @Idx(index = "2", type = NUMBER) @Pkg(label = "How
 long you would like to wait for this condition 
                        to be true?(Seconds)",
                                default_value = "0", default_value_type =
 DataType.NUMBER)
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                        @GreaterThanEqualTo("0") @LessThanEqualTo("99999")
 @NotEmpty @NumberInteger Double waitTimeout) {
 
        // Add the logic to check for the condition
    }   
}

The following example verifies if the provided boolean value is false.
Set commandType to Condition.

@BotCommand(commandType = Condition)
@CommandPkg(label = "False condition example", name =
 "conditionalTypeExample",
        description = "Checks if the boolean value is false.")
public class ConditionalTypeExample {
 
  @ConditionTest
     public Boolean validate(
             @Idx(index = "1", type = AttributeType.BOOLEAN)
             @VariableType(BOOLEAN)
             @Pkg(label = "Boolean variable", default_value_type = BOOLEAN)
 @NotEmpty Boolean variable
     ) {
         return variable == null ? false : !variable ;
     }

Понятия, связанные с данным
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.

Create an iterator using Package SDK
In Automation 360, you can create an iterator with the SDK package. An iterator is used to loop through
multiple objects of similar type and is used with the Цикл package. It consists of two methods, next and
hasNext, which return the actual object and a boolean value.

Required annotations

When iterator is used, the next method returns the next available value. If no more values are available,
an exception is shown. The hasNext method checks for other values and returns false if no more values
are available. In Automation 360, when the loop is executed, hasNext() is called first, and next() is
called only if hasNext() returned a true value.
For creating an iterator, the following annotations are required.

Аннотация Использование

BotCommand Use the BotCommand annotation with an iterator as the commandType.
This ensures that the plain old Java object (POJO) is eligible for creating an
Automation 360 iterator.

CommandPkg When creating a package, provide a name, label, and description to the
annotation.

Idx Annotate all parameters and member variables that are required and help with
the validation check, or they can be displayed in the interface for the input.
Provide the Idx and the type.
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Аннотация Использование

Pkg Annotate all parameters and member variables that will be displayed in the
interface. This annotation will be ignored if it is not accompanied by the Idx.

HasNext The method that has to be called for testing if the iteration has more elements
(returns true if next() returns an element rather than throwing an
exception). It must return a Boolean value.
If the method accepts parameters, then they must be annotated with the Idx.
The hasNext method verifies it and returns false if no more values are
available. InAutomation 360, when Цикл is executed, hasNext() is called
first. next() is called only if hasNext() returns a true value.

Next The method returns the next available value in the iteration. The return type is
a value. If no more value is available, an exception is shown.

Use case example
The example use case loops through number of times, for example, for (int i=0; I<n; i++) Java
construct. It accepts the value of n from the Bot Creator when the бот is created.
1. Make sure you have imported the following packages to ensure all the functionalities works as

described in the sample.

import com.automationanywhere.botcommand.data.Value;
import com.automationanywhere.botcommand.data.impl.NumberValue;
import com.automationanywhere.commandsdk.annotations.BotCommand;
import com.automationanywhere.commandsdk.annotations.CommandPkg;
import com.automationanywhere.commandsdk.annotations.HasNext;
import com.automationanywhere.commandsdk.annotations.Idx;
import com.automationanywhere.commandsdk.annotations.Inject;
import com.automationanywhere.commandsdk.annotations.Next;
import com.automationanywhere.commandsdk.annotations.Pkg;
import
 com.automationanywhere.commandsdk.annotations.BotCommand.CommandType;
import
 com.automationanywhere.commandsdk.annotations.rules.GreaterThanEqualTo;
import com.automationanywhere.commandsdk.annotations.rules.NotEmpty;
import com.automationanywhere.commandsdk.annotations.rules.NumberInteger;
import com.automationanywhere.commandsdk.model.AttributeType;
import com.automationanywhere.commandsdk.model.DataType;

2. Create the POJO class with the business logic.
Ensure that the POJO has a method and returns a boolean value. This will act as the comparison
method.

@BotCommand(commandType=CommandType.Iterator)
@CommandPkg(return_label = "Return the value in variable", node_label =
 ": {{times}} times", 
label = "Iterator demo", description = "Iterate number of times", name =
 "iteratorTypeDemo", return_type = DataType.NUMBER)
public class IteratorTypeDemo {
    @Idx(index = "1", type = AttributeType.NUMBER)
    @Pkg(label = "times", default_value = "10", default_value_type =
 DataType.NUMBER)
    @GreaterThanEqualTo("0")
    @NumberInteger
    @NotEmpty
    @Inject
 private Double times = 10d;
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 private Double counter = 0d;

    @HasNext
    public boolean hasNext() {
  return counter < times;
    }

    @Next
    public Value<Double> next() throws Exception{
  if (counter >= times)
   throw new Exception("Counter '"+ counter +"' is exceed the times limit
 '"+times+"'");

  counter++;
        NumberValue result = new NumberValue();
        result.set(counter);
        return result;
    }

    public void setTimes(Double times) {
        this.times = times;
    }
}

3. Annotate the POJO class to enable it for the Automation 360 iterator and to create a package.

@BotCommand(commandType = CommandType.Iterator)
@CommandPkg(return_label = "Return the value in variable", node_label =
 ": {{times}} times",
 label = "Iterator demo", description = "Iterate number of times", name =
 "iteratorTypeDemo", return_type = DataType.NUMBER)
public class IteratorTypeDemo {

 private Double times = 10 d;
 private Double counter = 0 d;

 public boolean hasNext() {
  return counter < times;
 }

4. Annotate the hasNext() and next() method appropriately.

@HasNext
public boolean hasNext() {
 return counter < times;
}

@Next
public Value < Double > next() throws Exception {
 if (counter >= times)
  throw new Exception("Counter '" + counter + "' is exceed the times
 limit '" + times + "'");

 counter++;
 NumberValue result = new NumberValue();
 result.set(counter);
 return result;
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}

The methods are named in easy-to-use way and are in parallel with the Java iterator interface. There
is no restriction from the SDK side when naming methods.
In an iterator, do not use parameter methods, but use setter injection.

5. Annotate the variables with Idx and Pkg.
Add @NotEmpty to ensure the value is not null, and add @GreaterThanEqualTo to ensure the
value is always greater than 0.

@Idx(index = "1", type = AttributeType.NUMBER)
@Pkg(label = "times", default_value = "10", default_value_type =
 DataType.NUMBER)
@GreaterThanEqualTo("0")
@NotEmpty
@Inject
private Double times = 10 d;

The attribute type number returns a Double.

Понятия, связанные с данным
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.

Create a trigger using Package SDK
When using Automation 360, you can create a trigger using the SDK package.

Using a trigger

Use Automation 360 to create a trigger. A trigger launches a бот when certain conditions are met and
waits until conditions have changed or stopped. When the conditions of the trigger are matched, the run
method is called to signal the trigger.

Required annotations

For creating a trigger, the following annotations are required:

Аннотация Использование

BotCommand Use the BotCommand annotation with the
trigger as commandType. This ensures that the
plain old Java object (POJO) is suitable for creating
the trigger with Automation 360.

CommandPkg These values are used when creating a package.
Provide a name, label, and description to the
annotation.

Idx Annotate all the parameters and member variables
that are required and help with the validation
check. Alternatively, they might be displayed in the
interface for the input. Provide the index (Idx) and
the type.
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Аннотация Использование

Pkg Annotate all the parameters and member variables
that will be shown in the interface. This annotation
will be ignored if it is not accompanied by the Idx.

StartListen Starts the trigger listener.

TriggerId A trigger ID, which is required for stopping the
trigger.

TriggerRunnable Provides the runnable. Calling the runnable sends a
signal that launches a бот associated with a trigger.

Use case example

The following use case shows how to create a timer trigger that triggers a бот at a regular interval.
1. Create the POJO class with the business logic:

public class TriggerDemo {
 
 private static final Timer TIMER = new Timer(true);
 
 public void startTrigger(Double interval) {
  TimerTask timerTask = new TimerTask() {

   @Override
   public void run() {
    // Do nothing

   }
  };

  TIMER.schedule(timerTask, interval.longValue());
 }

}

Multiple triggers of the same type can exist in a бот. All triggers are identified by a triggerId.
2. Add a triggerId to the class:

@TriggerId
 private String triggerUid;
 
 public String getTriggerUid() {
  return triggerUid;
 }

 public void setTriggerUid(String triggerUid) {
  this.triggerUid = triggerUid;
 }

3. Store the TimerTask separately so that when you want to stop a specific trigger, use the
triggerId.

private static final Map<String, TimerTask> taskMap = new
 ConcurrentHashMap<>();
 
 public void startTrigger(Double interval) {
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  TimerTask timerTask = new TimerTask() {

   @Override
   public void run() {
    // Do nothing

   }
  };
        taskMap.put(this.triggerUid, timerTask);
  TIMER.schedule(timerTask, interval.longValue());
 }

4. Start a trigger when conditions are met. Accept a runnable and call it appropriately.

@TriggerRunnable
 private Runnable runnable;
 
 public Runnable getRunnable() {
  return runnable;
 }

 public void setRunnable(Runnable runnable) {
  this.runnable = runnable;
 }
 
 public void startTrigger(Double interval) {
  TimerTask timerTask = new TimerTask() {

   @Override
   public void run() {
    runnable.run();

   }
  };
        taskMap.put(this.triggerUid, timerTask);
  TIMER.schedule(timerTask, interval.longValue());
 }

5. Stop the trigger, either individually (use a triggerId), or stop all triggers at the same time
(StopAllTriggers).

/*
  * Cancel all the task and clear the map.
  */
 @StopAllTriggers
 public void stopAllTriggers() {
  taskMap.forEach((k, v) -> {
   if (v.cancel()) {
    taskMap.remove(k);
   }
  });
 }

 /*
  * Cancel the task and remove from map
  *
  * @param triggerUid
  */
 @StopListen
 public void stopListen(String triggerUid) {
  if (taskMap.get(triggerUid).cancel()) {
   taskMap.remove(triggerUid);
  }
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 }

6. Add the remaining annotations.

@BotCommand(commandType = BotCommand.CommandType.Trigger)
@CommandPkg(label = "Demo Trigger", description = "Demo Trigger", icon =
 "email.svg", name = "demoTrigger")
public class TriggerDemo {
//Other code

 @StartListen
 public void startTrigger(@Idx(index = "1", type = AttributeType.NUMBER)
 @Pkg(label = "Please provide the interval to trigger in seconds",
 default_value = "120", default_value_type = DataType.NUMBER)
 @GreaterThan("0")
 @NumberInteger
 @NotEmpty
 Double interval) {
 //Other code
 }

}

Понятия, связанные с данным
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.

Custom triggers - pull and push mechanism
The examples provided in this topic demonstrate how to create time-based and event-based triggers, pull
(link TriggerDemo) and push (SimpleMessageListenerContainer) mechanisms using the SDK
package.

Пример. Time-based triggers - Pull mechanism

The required conditions of triggering are tested at the regular interval, in seconds.
• A trigger checks the database (DB) at regular intervals and if the SQL (DB) value that a user provides is

more than 0, then the timer-based trigger is triggered.
• When the event occurs, it runs the consumer.accept(<RecordValue Instance>) method and

triggers an associated bot.
• It verifies the conditions at each run.
• Add the valid DB driver in the build gradle file to run this example.

This example is an extension of the timer-based trigger (TriggerDemo) and demonstrates the trigger
pull mechanism.

Прим.:  This is an illustrative example and do not use it in the production environment.

@BotCommand(commandType = BotCommand.CommandType.Trigger)
@CommandPkg(label = "JDBC Query Trigger", description = "JDBC Query
 Trigger", icon = "jdbc.svg", name = "jdbcQueryTrigger",
  return_type = RECORD, return_name = "TriggerData", return_description =
 "Available keys: triggerType")
public class DBStatus {
 
 private static Logger logger = LogManager.getLogger(DBStatus.class);
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 // Map storing multiple tasks
 private static final Map<String, TimerTask> taskMap = new
 ConcurrentHashMap<>();
 private static final Timer TIMER = new Timer(true);

 @TriggerId
 private String triggerUid;
 @TriggerConsumer
 private Consumer consumer;

 /*
  * Starts the trigger.
  */
 @StartListen
 public void startTrigger(
   @Idx(index="1", type = AttributeType.TEXT)
   @Pkg(label = "Provide the database driver class")
   @NotEmpty
   String driverClassName,
   
   @Idx(index="2", type = AttributeType.TEXT)
   @Pkg(label = "Provide the Jdbc connection string")
   @NotEmpty
   String jdbcUrl,
   
   @Idx(index="3", type = AttributeType.TEXT)
   @Pkg(label = "Provide the user Name")
   @NotEmpty
   String userName,
   
   @Idx(index="4", type = AttributeType.CREDENTIAL)
   @Pkg(label = "Provide the password")
   @NotEmpty
   SecureString password,
   
   @Idx(index="5", type = AttributeType.TEXT)
   @Pkg(label = "Provide the SQL to check the records")
   @NotEmpty
   String sqlQuery,
   
   @Idx(index = "6", type = AttributeType.NUMBER)
   @Pkg(label = "Provide the interval to query in seconds", default_value =
 "300", default_value_type = DataType.NUMBER)
   @GreaterThan("0")
   @NumberInteger
   @NotEmpty
   Double interval) {
  
  DataSource dataSource = getDataSource(driverClassName, jdbcUrl, userName,
 password);
  
  TimerTask timerTask = new TimerTask() {

   @Override
   public void run() {
    logger.debug("checking DB");
    try {
     if(checkRecordsExist(dataSource.getConnection(), sqlQuery)){
      consumer.accept(getRecordValue());
      return;
     }
    } catch (SQLException e) {
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     logger.warn(e.getMessage(),e);
     logger.warn("Trigger is still running.");
    }
    logger.debug("no records found");

   }
  };

  taskMap.put(this.triggerUid, timerTask);
  TIMER.schedule(timerTask, interval.longValue(), interval.longValue());
 }

 private RecordValue getRecordValue() {
  List<Schema> schemas = new LinkedList<>();
  List<Value> values = new LinkedList<>();
  schemas.add(new Schema("triggerType"));
  values.add(new StringValue("DBStatus"));

  RecordValue recordValue = new RecordValue();
  recordValue.set(new Record(schemas,values));
  return recordValue;
 }
 /*
  * Cancel all the tasks and clear the map.
  */
 @StopAllTriggers
 public void stopAllTriggers() {
  taskMap.forEach((k, v) -> {
   if (v.cancel()) {
    taskMap.remove(k);
   }
  });
 }

 /*
  * Cancel the task and remove from the map
  *
  * @param triggerUid
  */
 @StopListen
 public void stopListen(String triggerUid) {
  if (taskMap.get(triggerUid).cancel()) {
   taskMap.remove(triggerUid);
  }
 }

    public static DataSource getDataSource(String driverClassName, String
 url, String userName,SecureString password) {
     BasicDataSource ds = new BasicDataSource();
     ds.setDriverClassName(driverClassName);
     ds.setUrl(url);
     ds.setUsername(userName);
     ds.setPassword(password.getInsecureString());
        return ds;
    }
 
    public static boolean checkRecordsExist(Connection con, String query)
         throws SQLException {
   
         Statement stmt = null;
         try {
             stmt = con.createStatement();
             ResultSet rs = stmt.executeQuery(query);
             rs.last();
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             if(rs.getRow() > 0)
              return true;
         } catch (SQLException e ) {
             throw new BotCommandException("Problem running statemnt", e);
         } finally {
             if (stmt != null) { stmt.close(); }
         }    
         return false;
     }  
 public String getTriggerUid() {
  return triggerUid;
 }
 public void setTriggerUid(String triggerUid) {
  this.triggerUid = triggerUid;
 }
 public Consumer getConsumer() {
  return consumer;
 }
 public void setConsumer(Consumer consumer) {
  this.consumer = consumer;
 }
}

Пример. Event-based triggers - Push mechanism

The trigger waits for an event to occur, for example, a message listener to start listening.
• An event details are stored in the memory and a message listener waits for a message.
• When the event occurs, it runs the consumer.accept(<RecordValue Instance>) method and

triggers an associated bot..

The following example shows how to create a simple ActiveMQ message listener
(SimpleMessageListenerContainer) to demonstrate the trigger push mechanism.

@BotCommand(commandType = BotCommand.CommandType.Trigger)
@CommandPkg(label = "JMS Trigger", description = "JMS Trigger", icon =
 "jms.svg", name = "jmsTrigger",
  return_type = RECORD, return_name = "TriggerData", return_description =
 "Available keys: triggerType")
public class JMSQueue implements SessionAwareMessageListener {

 // Map storing multiple MessageListenerContainer
 private static final Map<String, MessageListenerContainer> taskMap = new
 ConcurrentHashMap<>();

 @TriggerId
 private String triggerUid;
 @TriggerConsumer
 private Consumer consumer;
 
 //This method is called by MessageListenerContainer when a message arrives.
 // At this point, the trigger get enabled 
 @Override
 public void onMessage(javax.jms.Message message, Session session) throws
 JMSException {
  consumer.accept(getRecordValue());

 }

 private RecordValue getRecordValue() {
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  List<Schema> schemas = new LinkedList<>();
  List<Value> values = new LinkedList<>();
  schemas.add(new Schema("triggerType"));
  values.add(new StringValue("JMSQueue"));

  RecordValue recordValue = new RecordValue();
  recordValue.set(new Record(schemas,values));
  return recordValue;
 }
 /*
  * Starts the trigger.
  * 
  * Use this method to setup the trigger, such as, setup the
 MessageListenerContainer and start it.
  */
 @StartListen
 public void startTrigger(@Idx(index = "1", type = AttributeType.TEXT)
 @Pkg(label = "Provide the broker URL")
 @NotEmpty
 String brokerURL, @Idx(index = "2", type = AttributeType.TEXT)
 @Pkg(label = "Provide the queue name")
 @NotEmpty
 String queueName) {
  
  if (taskMap.get(triggerUid) == null) {
   synchronized (this) {
    if (taskMap.get(triggerUid) == null) {
     SimpleMessageListenerContainer messageListenerContainer = new
 SimpleMessageListenerContainer();
     messageListenerContainer.setConnectionFactory(new
 PooledConnectionFactory(brokerURL));
     messageListenerContainer.setDestinationName(queueName);
     messageListenerContainer.setMessageListener(this);
     messageListenerContainer.start();
     taskMap.put(triggerUid, messageListenerContainer);

    }
   }
  }

 }

 /*
  * Cancel all the tasks and clear the map.
  */
 @StopAllTriggers
 public void stopAllTriggers() {
  taskMap.forEach((k, v) -> {
   v.stop();
   taskMap.remove(k);
  });
 }

 /*
  * Cancel the tasks and remove from the map
  *
  * @param triggerUid
  */
 @StopListen
 public void stopListen(String triggerUid) {
  taskMap.get(triggerUid).stop();
  taskMap.remove(triggerUid);
 }
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 public String getTriggerUid() {
  return triggerUid;
 }

 public void setTriggerUid(String triggerUid) {
  this.triggerUid = triggerUid;
 }

 public Consumer getConsumer() {
  return consumer;
 }

 public void setConsumer(Consumer consumer) {
  this.consumer = consumer;
 }

}

Понятия, связанные с данным
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.

Add debug logs of custom packages to bot_launcher.log file
You can add logs using log4j. The dependency is already added in the package SDK sample
build.gradle file. Review the logging info using RadioTypeDemo.java file.

Example 1: Logger info - Get region value using RadioTypeDemo class

1. Review the code example where the logger is added in the code, open the RadioTypeDemo.java
file located at <your latest package-sdk-2.0.9\src\main\java\com
\automationanywhere\botcommand\samples\commands\basic\types

@BotCommand
@CommandPkg(label = "[[RadioTypeDemo.label]]", 
description = "[[RadioTypeDemo.description]]", icon = "sample.svg", name
 = "radioTypeDemo")
public class RadioTypeDemo {

 private static Logger logger =
 LogManager.getLogger(RadioTypeDemo.class);
 
 @Execute
 public void getRegionValue(@Idx(index = "1", type = AttributeType.RADIO,
 options = {
   @Idx.Option(index = "1.1", pkg = @Pkg(label =
 "[[RadioTypeDemo.region.1.1.label]]", value = "us_east")),
   @Idx.Option(index = "1.2", pkg = @Pkg(label =
 "[[RadioTypeDemo.region.1.2.label]]", value = "us_west")),
   @Idx.Option(index = "1.3", pkg = @Pkg(label =
 "[[RadioTypeDemo.region.1.3.label]]", value = "us_central"))
 })
 @Pkg(label = "[[RadioTypeDemo.region.label]]")
 @NotEmpty
 String region) {
  logger.info("Selected region is {}", region);
 }

2. Build a simple bot from the Automation 360 Demo package and select a radio group: Radio Demo.
3. Select an appropriate region, such as, US East.

© 2023 Automation Anywhere. All rights reserved.     2417



    Automation Anywhere - Сборка

4. Save and run the bot.
5. Access the folder where the logs were generated, the default log location: C:\ProgramData

\AutomationAnywhere\BotRunner\Logs\Bot_Launcher.log.
If the logs get roll back from the Bot_Launcher.log file, then logs will create a folder based on the
month when they were created, for example, 2021-May. Inside this folder, the logs will continue to
generate.

6. Open the Bot_Launcher.log file and review the log info for the RadioTypeDemo and selected
region is us_east.

Example 2: Assigning a value to clipboard
The following example accepts a user input or a variable and assigns it to clipboard.

@BotCommand
@CommandPkg(label = "Copy to",icon="assigntoclipboard.svg" ,name =
 "assignToClipboard", description
  = "Accepts user input or a variable and assigns it to Clipboard",
 node_label="{{value}}")
public class AssignToClipboard {

 private static Logger logger =
 LogManager.getLogger(AssignToClipboard.class);

 @Execute
 public static void assign(@Idx(index = "1", type = TEXT) @Pkg(label =
 "Value") @NotEmpty String
           value) {

  logger.trace("Assigning '{}' value to clipboard.", value);
 }
}

Понятия, связанные с данным
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.

Handle sessions in a custom package
You can extract a session using a session name from the SessionsMap. In the same package, you can use
sessions to pass information between actions, but not to other packages.

Configure the following attributes

• Apply an annotation to the class field and add a corresponding public setter.
• Retrieve the SessionsMap using the Sessions attribute.
• Set the variable type as Map<String, Object>.
• Set the attributeType: TEXT or SESSION. If type = TEXT, it is a regular session; if type =

 SESSION, it is a sharedSession.

Start a new session

@BotCommand
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@CommandPkg(label = "Start session", name = "startSession", description =
 "Start new session", 
icon = "pkg.svg", node_label = "start session {{sessionName}}|") public
 class Start {
 
    @Sessions
    private Map<String, Object> sessions;
     
    @Execute
    public void start(@Idx(index = "1", type = TEXT) @Pkg(label = "Session
 name", 
    default_value_type = STRING, default_value = "Default") @NotEmpty String
 sessionName) {
 
        // Check for existing session
        if (sessions.containsKey(sessionName))
            throw new
 BotCommandException(MESSAGES.getString("xml.SessionNameInUse",
 sessionName));
 
        // Do some operation
 
        // Create new session
        sessions.put(sessionName, new Session(operation));
    }
    public void setSessions(Map<String, Object> sessions) {
        this.sessions = sessions;
    }
}

End a session

@BotCommand
@CommandPkg(label = "End session", name = "endSession", description = "End
 session", icon = 
"pkg.svg", node_label = "End session {{sessionName}}|")
public class EndSession {
    @Sessions
    private Map<String, Object> sessions;
    @Execute
    public void end(
            @Idx(index = "1", type = TEXT) @Pkg(label = "Session name",
 default_value_type = STRING, 
            default_value = "Default") @NotEmpty String sessionName) {
                 
        sessions.remove(sessionName);   
    }  
    public void setSessions(Map<String, Object> sessions) {
        this.sessions = sessions;
    }
}
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Add a session
In the below example, string objects are used (although in real actions, you can use complex objects).

@BotCommand
@CommandPkg(label = "[[SessionDemo.label]]", description =
 "[[SessionDemo.description]]", icon = "sample.svg", name = "sessionDemo")
public class SessionDemo {

 // Sessions are provided as a Map. Actions can add or remove entries in
 this
 // Map.
 // The choice to reuse/overwrite/delete/add any Object in this Map belongs
 to
 // the actions, and the framework makes no assumption regarding it.
 @Sessions
 private Map<String, Object> sessionMap;

 @Execute
 public void execute(@Idx(index = "1", type = TEXT)
 @Pkg(label = "[[SessionDemo.name.label]]")
 @NotEmpty
 String name) {
  if (!sessionMap.containsKey(name))
   sessionMap.put(name, "Some Value");
 }

 // Ensure that a public setter exists.
 public void setSessionMap(Map<String, Object> sessionMap) {
  this.sessionMap = sessionMap;
 }
}

Set a session variable
The below example shows how to develop an action (for example, Set session variable). In the
action, the session details are retrieved and stored as a session variable so that the information can be
used within a specific package.

@BotCommand
@CommandPkg(label = "[[SessionDemo2.label]]", description =
 "[[SessionDemo2.description]]", icon = "sample.svg", name = "SessionDemo2",
return_type = DataType.STRING)
public class SessionDemo2 {

 // Sessions are provided as a Map. Actions can add or remove entries in
 this
 // Map.
 // The choice to reuse/overwrite/delete/add any Object in this Map belongs
 to
 // the actions, and the framework makes no assumption regarding it.
 @Sessions
 private Map<String, Object> sessionMap;

 @Execute
 public Value<?> execute(@Idx(index = "1", type = TEXT)
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 @Pkg(label = "[[SessionDemo2.name.label]]")
 @NotEmpty
 String name) {
  if (sessionMap.containsKey(name)) {
   return new StringValue(sessionMap.get(name));
  } 
  return new StringValue("session does not exist");
 }
 // Ensure that a public setter exists.
 public void setSessionMap(Map<String, Object> sessionMap) {
  this.sessionMap = sessionMap;
 }
}

Понятия, связанные с данным
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.

Configure shared session using Package SDK
Package SDK provides configuration for the SDK users to create and use shared sessions. Sessions are
seamlessly shared between different bots to share resources between them. This means that if a session
has been created, the other TaskBots can read and update the session and vice versa.

Share session between parent and child

The following section describes creating a shared session. The parent GlobalSessionDemoUpperCaseParent
returns a Session value to the global session and is used by the child bot GlobalSessionDemoUpperCaseChild.

Прим.:  Place the three classes below in the following location: <PackageSDK>\src\main\java\com
\automationanywhere\botcommand\samples\commands\basic

1. Create the following POJO class DemoForSession that implements CloseableSessionObject.

package
 com.automationanywhere.botcommand.samples.commands.basic.GlobalSessionSampleProject;

import
 com.automationanywhere.toolchain.runtime.session.CloseableSessionObject;

import java.io.IOException;

public class DemoForSession implements CloseableSessionObject
{
    public void setClose(boolean close) {
        this.close = close;
    }

    boolean close=false;
    public String getDemo() {
        return demo;
    }

    public void setDemo(String demo) {
        this.demo = demo;
    }
    public DemoForSession(String demo){
        this.demo=demo;
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    }
    String demo;

    @Override
    public boolean isClosed() {
        return close;
    }

    @Override
    public void close() throws IOException {

    }
}

2. Add the @BotCommand annotation to make a class as an Action in the Control Room. For more
information on annotations, see Annotations.

@BotCommand

3. Add the @CommandPkg annotation to define all the UI related components - labels, description , icon,
return_type, and name. The elements return_label, return_settings, return_type, and return_required
belonging to the @CommandPkg ensures that the SESSION is returned by the parent bot.

@CommandPkg(
  //Unique name inside a package and label to display.
  name = "GlobalSession", label = "Global session uppercase parent",
  node_label = "Shared session parent node label", description = "Shared
 session parent description", icon = "pkg.svg",
  
  //Return type information. return_type ensures only the right kind of
 variable is provided on the UI. 
  return_label = "Return the parent session",
  return_settings = {ReturnSettingsType.SESSION_TARGET},
  return_type = SESSION,
  return_required = true)

4. Create the GlobalSessionDemoUpperCaseParent object. The GlobalSessionDemoUpperCaseParent gets a
lower case string input from the action's input, converts it to an upper case string and store the result
in the SessionValue.
• Annotate the method with @Execute to execute the method during compilation.

package
 com.automationanywhere.botcommand.samples.commands.basic.GlobalSessionSampleProject;

import com.automationanywhere.botcommand.data.impl.SessionValue;
import com.automationanywhere.commandsdk.annotations.*;
import com.automationanywhere.commandsdk.annotations.rules.NotEmpty;
import com.automationanywhere.commandsdk.model.ReturnSettingsType;
import org.apache.logging.log4j.LogManager;
import org.apache.logging.log4j.Logger;

import java.util.Map;

import static
 com.automationanywhere.commandsdk.model.AttributeType.TEXT;
import static com.automationanywhere.commandsdk.model.DataType.SESSION;

//BotCommand makes a class eligible for being considered as an action.
@BotCommand
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//CommandPks adds required information to be dispalable on GUI.
@CommandPkg(
  //Unique name inside a package and label to display.
  name = "GlobalSession", label = "Global session uppercase parent",
  node_label = "Shared session parent node label", description =
 "Shared session parent description", icon = "pkg.svg",
  
  //Return type information. return_type ensures only the right kind of
 variable is provided on the UI. 
  return_label = "Return the parent session",
  return_settings = {ReturnSettingsType.SESSION_TARGET},
  return_type = SESSION,
  return_required = true)
public class GlobalSessionDemoForStringUpperCaseParent {
 private static Logger logger =
 LogManager.getLogger(GlobalSessionDemoForStringUpperCaseParent.class);

 //Identify the entry point for the action. Returns a SessionValue
 because the return_type is SESSION. 
 @Execute
 public SessionValue action(
   //Idx 1 would be displayed first, with a text box for entering the
 value.
   @Idx(index = "1", type = TEXT) 
   //UI labels.
   @Pkg(label = "Enter string in lower case")
   //Ensure that a validation error is thrown when the value is null.
   @NotEmpty 
   String firstString) {
  String result = firstString.toUpperCase();
  DemoForSession demoForSession= new DemoForSession(result);
  return SessionValue
    .builder()
    .withSessionObject(demoForSession)
    .build();
 }
}

5. Create the GlobalSessionDemoUpperCaseChild object. The GlobalSessionDemoUpperCaseChild gets a
lower case string input from the action's input, converts it to upper case and concatenates it with the
SessionValue received from the parent bot.

package
 com.automationanywhere.botcommand.samples.commands.basic.GlobalSessionSampleProject;

import com.automationanywhere.botcommand.data.Value;
import com.automationanywhere.botcommand.data.impl.StringValue;
import
 com.automationanywhere.botcommand.samples.commands.basic.Uppercase;
import com.automationanywhere.commandsdk.annotations.*;
import com.automationanywhere.commandsdk.annotations.rules.NotEmpty;
import com.automationanywhere.commandsdk.annotations.rules.SessionObject;
import com.automationanywhere.commandsdk.model.AttributeType;
import com.automationanywhere.commandsdk.model.DataType;
import org.apache.logging.log4j.LogManager;
import org.apache.logging.log4j.Logger;

import static com.automationanywhere.commandsdk.model.AttributeType.TEXT;
import static com.automationanywhere.commandsdk.model.DataType.STRING;

//BotCommand makes a class eligible for being considered as an action.
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@BotCommand

//CommandPks adds required information to be dispalable on GUI.
@CommandPkg(
  //Unique name inside a package and label to display.
  name = "GlobalSessionChild", label = "Global session upper case child",
  node_label = "Global session child node label",
  description = "Global session child description", icon = "pkg.svg",
  
  //Return type information. return_type ensures only the right kind of
 variable is provided on the UI. 
  return_label = "Return the concatenated string to", return_type =
 STRING, return_required = true)
public class GlobalSessionDemoUpperCaseChild {
 private static Logger logger = LogManager.getLogger(Uppercase.class);
 
 @Execute
 public Value<String> action(
   //Idx 1 would be displayed first, with a text box for entering the
 value.
   @Idx(index = "1", type = TEXT) 
   //UI labels.
   @Pkg(label = "Enter a sting in lower case to concatenate")
   //Ensure that a validation error is thrown when the value is null.
   @NotEmpty 
   String sourceString,
   @Idx(index = "2", type = AttributeType.SESSION)
   @Pkg(label = "sharedSession", description = "sharedSession",
     default_value = "Default", default_value_type = DataType.SESSION)
   //Using the sessionObject annotation here as its a consumer class
     @SessionObject
     DemoForSession session) {

  //Business logic
  String result = sourceString.toUpperCase();
  logger.info("session: {}",session);
  return new StringValue(result+session.getDemo().toUpperCase());
 }
}

6. Build and upload the custom package to the Control Room. For more information on uploading the
package, see Using the package SDK.

7. Create a бот by using the Global session uppercase parent action.
a. Enter a lower case string (For example: parentbot string)
b. Enter a name for the session. The parent bot returns the value to the Global session (For

example: Global)

8. Create a TaskBots by using the Global session upper case child action. You will be able to input a
lower case string and also get the string from the shared parent session. Concatenate the parent and
child strings.
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9. Use a Message box to show the output.
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10. Now call the Global session upper case child into the parent.

11. Run the parent bot and you will see the message box showing the value from the Child bot which it
derived using the Shared global session.

Build боты to share session details using Package SDK
A shared session enables you to reuse actions between TaskBots that run concurrently, for example, using
the same Excel file to pass values.
Ensure you have the following to build a TaskBot:
• Access to the Control Room
• Credentials with AAE_Basic permissions
• A development license, which enables you to create and run TaskBots
• Your workstation is a registered device in the Control Room
• An Excel file that you want to use in the shared session actions

1. Войдите в Control Room.
2. Create three TaskBots that will share the shared session actions.
3. Create a new childSession2 variable of Type > Session and Session type > MS Excel session,

select Use as input, and then click Apply.
4. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
5. Click the Create a bot icon.
6. Create a new бот called childBot2.

a) In the Name field, enter childBot2.
b) In the Actions pane, find Excel Advanced, and drag Get current worksheet name to the Bot

editor.
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c) In Session name > Shared session, enter F2 > childSession2, and in Assign the output
to variable, select prompt-assignment.

7. Create a new parentSession variable of Type > Session and Session type > MS Excel session, and
then click Apply.

8. Create a new бот called parentSession, and click Create & Edit.
9. In the Actions pane, find Excel Advanced, and drag Open to the Bot editor.

a) In File path, select Desktop file, click Browse, and navigate to the Excel file that you want to
use.

b) In Session name, retain Default.
c) Щелкните Сохранить.

10. Create a new childSession1 variable of Type > Session and Session type > MS Excel session,
select Use as input, and then click Apply.

11. Create a new бот called childBot1.
a) In the Name field, enter childBot1.
b) In the Actions pane, find Excel Advanced, and drag Get single cell to the Bot editor.
c) Select Active cell in Session name, and select Local name, enter F2, and then in Store cell

content to, select prompt-assignment.

12. In the Actions pane, find Excel Advanced, and drag Set session variable to the Bot editor.
a) In Session name, retain Default.
b) In Save session to a variable, select parentSession.

13. From the Actions pane, find Task Bot, and drag Run to the Bot editor.
a) In Task Bot to run, select Control Room file, click Choose, and then Browse, and select

childBot1.
b) In Input values, select Set childSession1, enter F2, and select parentSession.

14. In the Actions pane, find Excel Advanced, and drag Close, select Session name as Local name,
and retain Default.

15. In the Actions pane, find Message box. In Enter the message to display, enter F2, and then
select prompt-assignment.

16. From the Actions pane, select Task Bot, and drag Run to the Bot editor.
a) In Task Bot to run, select Control Room file, click Choose, and then Browse, and then

select childBot2.
b) In Input values, select Set childSession2, enter F2, and select childSession1.

17. In the Actions pane, find Message box. In Enter the message to display, enter F2, and select
prompt-assignment.

18. Save all three боты and run the parentSession TaskBot.

The following three messages are displayed:
Single cell value from parent bot:1

Current worksheet name of excel opened in parent bot: Sheet1 <name of the
sheet>

Your bot has run successfully!
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Понятия, связанные с данным
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.

Annotations
This section provides reference information about the annotations used to create Automation Anywhere
packages.
• Creation and function annotations

List of the available creation and function annotations.
• Validation annotations

Validates annotated strings and values used in the Java code.
• Configure and use credential allow password annotation

Use the provided CredentialTypeDemo.java package SDK file and configure the
CredentialAllowPassword annotation for the password field in Automation 360 ячейка actions.

Понятия, связанные с данным
Standard coding practices and guidelines for developing packages
This topic covers standard coding practices and guidelines that help to ensure the development of high
quality packages.
How to examples
This section contains code examples and explanations about how to code some basic бот capabilities.
Задачи, связанные с данной
Set up the Java project
Set up an integrated development environment (IDE) for Java, including Automation Anywhere custom
annotations to develop an action package that you can upload to your Control Room.
Develop a sample package
Develop your own package and upload it to an Control Room to provide custom actions for ботs.

Creation and function annotations
List of the available creation and function annotations.

Annotation: BotCommand

Makes the type eligible to be treated as an action. You can define three types of actions commandType
property.
• Command\Action
• Условие
• Итератор

Examples:
• @BotCommand(commandType = BotCommand.CommandType.Iterator)
• @BotCommand(commandType = Condition)
• @BotCommand(commandType = Varialbe)
• @BotCommand(commandType = Trigger)
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Annotation: CommandPkg

Makes the type eligible for creation of action package.json. This annotation must be used with
BotCommand to take effect.Pkg participates in the activity only when this annotation is present.
Пример.

@CommandPkg(label = "Create", name = "createFile", 
description = "Creates a file", node_label = "{{filePath}}", 
icon = "file.svg")

Annotation: ConditionTest

Participates in the Condition execution. This annotation can only be used when the BotCommand
has commandType set as Condition. Only one method needs to be annotated when BotCommand
annotation is present on the type. Failure to do so will result in the compilation error.

Annotation: Выполнить

Participates in the execution of BotCommand. Exactly one method needs to be annotated when
BotCommand annotation is present on the type. Failure to do so will result in the compilation error.
Пример.

@Execute public void create( @Idx(index = "1", type = FILE) @LocalFile
 @Pkg(label = 
"File", description = "e.g. C:\\MyDoc\\MyFile.doc") @NotEmpty String
 filePath, 
@Idx(index = "2", type = CHECKBOX) @Pkg(label = "Overwrite an existing
 file") 
@NotEmpty Boolean isOverwrite) { createFile(filePath, isOverwrite); }

Annotation: GlobalSessionContext

Can only be applied to member variables and fetches the GlobalSessionContext through a setter.
Пример.

@com.automationanywhere.commandsdk.annotations.GlobalSessionContext
    private GlobalSessionContext globalSessionContext;

    public void setSessionMap(Map < String, Object > sessionMap) {
     this.sessionMap = sessionMap;
    }
    public void
 setGlobalSessionContext(com.automationanywhere.bot.service.GlobalSessionContext
 globalSessionContext) {
     this.globalSessionContext = globalSessionContext;
    }
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Annotation: HasNext

Participates in the execution of Iterator. This annotation can only be used when the BotCommand
has commandType set as Iterator. Requires the Next annotation to be present. One method needs
to be annotated when BotCommand annotation is present on the type. Failure to do so will result in the
compilation error.

Annotation: Индекс

Makes the annotated element part of hierarchy utilized for the code and resource generation. Without this
annotation no BotCommand related element annotations would be processed.

Annotation: Idx.Option

An option represents the elements that would play in the hierarchy, but lend the values to the parents.
Examples:
• RADIO

@Idx(index = "1", type = RADIO, options = {
    @Idx.Option(index = "1.1", pkg = @Pkg(node_label
 = "[[Delay.delayType.1.1.node_label]]", label =
 "[[Delay.delayType.1.1.label]]", value = REGULAR)),
    @Idx.Option(index = "1.2", pkg = @Pkg(node_label
 = "[[Delay.delayType.1.2.node_label]]", label =
 "[[Delay.delayType.1.2.label]]", value = RANDOM))
})
@Pkg(label = "[[Delay.delayType.label]]", default_value = "REGULAR",
 default_value_type = DataType.STRING)
@Inject
private String delayType;

• SELECT

@Idx(index = "2", type = SELECT, options = {
@Idx.Option(index = "2.1", pkg = @Pkg(label =
 "[[LaunchWebsite.browser.2.1.label]]", value = "DEFAULT")),
@Idx.Option(index = "2.2", pkg = @Pkg(label =
 "[[LaunchWebsite.browser.2.2.label]]", value = "INTERNET_EXPLORER")),
@Idx.Option(index = "2.3", pkg = @Pkg(label =
 "[[LaunchWebsite.browser.2.3.label]]", value = "FIREFOX")),
@Idx.Option(index = "2.4", pkg = @Pkg(label =
 "[[LaunchWebsite.browser.2.4.label]]", value = "CHROME"))
}) @Pkg(label = "[[LaunchWebsite.browser.label]]", default_value =
 "DEFAULT", default_value_type = DataType.STRING) @NotEmptyStringbrowser)

Annotation: Inject

Makes an element eligible for injection into the annotated type object. The injection is setter-based so
a corresponding setter in the type is mandatory. The injected values would form the BotCommand
parameter map using the name provided in Idx.
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Annotation: Вперед

Participates in the Iterator execution. This annotation can only be used when the BotCommand has
commandType set as Iterator. Requires the HasNext annotation to be present. One method needs
to be annotated when BotCommand annotation is present on the type. Failure to do so will result in
compilation error.

Annotation: Pkg

Makes an element to participate in the package.json creation. This annotation is ignored when Idx is
not present.
Понятия, связанные с данным
Annotations
This section provides reference information about the annotations used to create Automation Anywhere
packages.

Validation annotations
Validates annotated strings and values used in the Java code.

Аннотация Описание

CodeType The MIME-type of the code to format.

CredentialOnly Can only accept a credential value, no string
allowed.

Equals Validates that the given string is equal to the
annotated string variable.

FileExtension Validates the annotated string value that ends
with the supported extension type.

GreaterThan Validates that the annotated number variable
value is always greater than the given numeric
value.

GreaterThanEqualTo Validates that the annotated number variable
value is always greater than or equal to the
given numeric value.

LessThan Validates that the annotated number variable
value is always less than the given numeric
value.

LessThanEqualTo Validates that the annotated number variable
value is always less than or equal to the given
numeric value.

LocalFile Can only accept local paths and no file
expression.

MatchesRegex Validates that the annotated string value
matches the given regular expression.
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Аннотация Описание

NotEmpty Validates and throws an exception when the
annotated variable value is null.

@Execute
public
 Value<Double>length(@Idx(index="1",
    type=TEXT)@Pkg(label="Source
 string")@NotEmpty String 
    sourceString){}

NotEquals Validates that the given string is not be equal to
the annotated string variable.

NotMatchesRegex Validates that the annotated string value does
not match the given regular expression.

NumberInteger Ensures the UI accepts only integers and not
double for the annotated variable value.

RepositoryFile Can only accept repository paths and no file
expression.

VariableNotPackage Cannot choose a variable from this package.

VariablePackage Can only choose a variable from this package.

VariableSubType The variable subtype must match.

VariableType The variable type must match.

VariableUserDefined Can only choose a user-defined variable.

Понятия, связанные с данным
Annotations
This section provides reference information about the annotations used to create Automation Anywhere
packages.

Configure and use credential allow password annotation
Use the provided CredentialTypeDemo.java package SDK file and configure the
CredentialAllowPassword annotation for the password field in Automation 360 ячейка actions.
Пример. Review the CredentialTypeDemo.java
Use the following CredentialTypeDemo.java file located at: <latest package-sdk>2.0.9\src
\main\java\com\automationanywhere\botcommand\samples\commands\basic\types as an
example on how to configure the credential attribute.

@BotCommand
@CommandPkg(label = "[[CredentialTypeDemo.label]]", 
description = "[[CredentialTypeDemo.description]]", icon = "sample.svg",
 name = "credentialTypeDemo")
public class CredentialTypeDemo {

 private static Logger logger =
 LogManager.getLogger(CredentialTypeDemo.class);

 /**
  * To accept credentials the {@link AttributeType} in index should be
  * {@link AttributeType.CREDENTIAL CREDENTIAL}. A {@link SecureString} is
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  * provided for any credentials type.
  */
 @Execute
 public void printCredentials(@Idx(index = "1", type =
 AttributeType.CREDENTIAL)
 @Pkg(label = "[[CredentialTypeDemo.credentials.label]]")
 SecureString credentials) {
  // SecureString provides multiple way to access the data inside.
  // Let's try to get the user name and print it in logs.

  // To get the username as String
  String userName = credentials.getInsecureString();
  logger.trace("User name from getInsecureString : {}", userName);

Пример. Configure the credential attributes @Execute
Configure the index, type, label, optional description, and the credentialAllowPasswordAttribute. When
creating a new or updating an existing package, use the CredentialAllowPassword annotation to allow
the credential picker to pick a credential attribute marked as a password field.

@Execute
 public void printCredentials(@Idx(index = "2", type =
 AttributeType.CREDENTIAL)
 @Pkg(label =
 "[[CredentialTypeDemo.credentialsAllowPasswordAttribute.label]]")
 @CredentialAllowPassword SecureString credentialAllowPasswordAttribute) {

Configure the attributes in theControl Room
In the Attribute name field, enter password and an optional description, in Input field, select
Standard, and enter the Value. In the Security field, select Use attribute only on Password or
Masked fields.

Use the credential attribute inControl Room
• In the Pick a credential field, select credential. In the Attribute field, select username. In the

Provide the credential for the user (optional) field, select Credential, and then Pick.
• In the Attribute field, select password. In the Provide the credential for the password

(optional) field, select Credential, and then Pick.

Build and test a demo package and бот
This practical how to section demonstrates that creating, changing, and managing packages allow you to
customize actions and efficiently manage packages for all Control Room users.
Here is a list of all the necessary tasks to create a package, add the package to your Control Room, and
verify your work in a бот. Complete the listed tasks in order.

Совет:  Click the title of each step to go the detailed task.

Step 1 Update related workflow and build files Follow the detailed steps for updating workflow
and build files for this project using your integrated
development environment (IDE).
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Step 2 Choose your favorite IDE You can compile a пакет from the IDE of your
choice. Here are two possible ways you can compile
a package:

Compile a demo JAR file
from the Eclipse UI

Use Eclipse to compile a
demo JAR file that you
can add as a package to
your Control Room.

Compile a demo JAR file
from the command line

Compile the demo Java
code provided with this
software development
kit.

Step 3 Add your demo package to the Control Room Users with Upload package permission can add
packages to the Control Room for use by all Bot
Creator.

Step 4 Create a demo бот with the demo package Create a бот using the demo package to verify the
actions that were created.

Step 5 Change the Java file used to create the package
JAR file

Modify and compile the Java code used to create a
package to fix issues and create new functionality.

Step 6 Upload new demo package Package management allows you to upload package
updates. The new package has the same name, but
a different version number.

Step 7 Update the demo бот with the updated package Update боты to use specific package versions.

Update related workflow and build files
Follow the detailed steps for updating workflow and build files for this project using your integrated
development environment (IDE).
Complete all the steps for project setup detailed in Set up the Java project.
This task shows you how to update the appropriate build and workflow files.
1. Open the project "A2019DemoPakcage" that you created in Set up the Java project.

You can find the project file in the directory where you extract the zip files to, for example c:
\A2019DemoPackage.

2. From inside the project, Open the settings.gradle file.
3. Replace the project name with A2019DemoPackageFirstnameLastname.

If your name is John Developer it would look like this, A2019DemoPackageJohnDeveloper.
4. Open src > main > resources > package.template.
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5. Update the name, label, and description values.

Original package.template Updated package.template

{
  "name": "A2019DemoPackage",
  "label": "A2019DemoPackage",
  "description": "Provides
 actions for A2019DemoPackage
 operations.",
  "group": "",
  "artifactName": "",
  "packageVersion": "",
  "codeVersion": "",
  "commands": []
}

{
  "name":
 "A2019DemoPackageFirstnameLastname",
  "label":
 "A2019DemoPackageFirstnameLastname",
  "description":
 "A2019DemoPackageFirstnameLastname",
  "group": "",
  "artifactName": "",
  "packageVersion": "",
  "codeVersion": "",
  "commands": []
}

6. Сохраните изменения.

After you have setup the build files, you need to compile the demo Java code, Compile a demo JAR file from
the command line.

Compile a demo JAR file from the Eclipse UI
Use Eclipse to compile a demo JAR file that you can add as a package to your Control Room.
Before starting this task complete the steps in Update related workflow and build files.
Build a package file using a Gradle project in the Eclipse IDE.
1. Import the A2019DemoPackage as a Gradle project, File > Import > Gradle > Existing Gradle

Project and click Finish.
2. From the Gradle Tasks tab, go to <your project> > build and run the following tasks in order.

a) <your project> > build > clean
b) <your project> > build > build

3. From the Gradle Tasks tab, go to <your project. > shadow and run the shadowJar task.
Your compiled package file is located in file:\ \A2019DemoPackage\build\libs\. The package file
has named after your project name (<your project>-1.0.0.jar).

To add your custom package to your Control Room follow the instructions in Add пакеты to the Control
Room.
Понятия, связанные с данным
Build and test a demo package and бот
This practical how to section demonstrates that creating, changing, and managing packages allow you to
customize actions and efficiently manage packages for all Control Room users.

Compile a demo JAR file from the command line
Compile the demo Java code provided with this software development kit.
Before starting this task complete the steps in Update related workflow and build files.
1. Open a terminal window and go to where the gradlew.bat file is located.

...\A2019DemoPackage > gradlew.bat
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2. In the terminal window, type gradlew.bat clean build shadowJar, and press Enter. Here is
an example of what you see:

> . . .\A2019DemoPackage>gradlew.bat clean build shadowJar

> Task :compileJava
Note: Starting hierarchy discovery for
 'com.automationanywhere.botcommand.demo.Concatenate'
Note: Starting non-hierarchical element discovery for
 'com.automationanywhere.botcommand.demo.Concatenate'
Note: Starting hierarchy discovery for
 'com.automationanywhere.botcommand.demo.Uppercase'
Note: Starting non-hierarchical element discovery for
 'com.automationanywhere.botcommand.demo.Uppercase'
Note: Starting Command Java generator...
Note: Starting Json generator...
Note: Generating command json for Concatenate
Note: Generating command json for Uppercase

> Task :commandCodeGen
mergeJsonFiles: updatePackage: group com.automationanywhere ,
 artifactName A2019DemoPackageFirstnameLastname , 
packageVersion 1.0.0-20190816-101906

The compiled file is located in file:\ \A2019DemoPackage\build\libs\.

To add your custom package to your Control Room follow the instructions in Add пакеты to the Control
Room.
Понятия, связанные с данным
Build and test a demo package and бот
This practical how to section demonstrates that creating, changing, and managing packages allow you to
customize actions and efficiently manage packages for all Control Room users.

Add your demo package to the Control Room
Users with Upload package permission can add packages to the Control Room for use by all Bot Creator.
Before you can upload a package, you need valid user login credentials with Upload package permission
for the Control Room you are adding the package to.
To add a package from a source other than Bot Store, follow these steps:
1. Перейдите в раздел Управление > Пакеты.
2. Click Add package.
3. Щелкните Обзор.
4. Locate and select the пакет to add to the Control Room.

Пакеты are Java Archive (JAR) files that contain actions used to create боты.
5. Click Upload package.
6. On the Bots > Packages > Confirm package page, choose any of the following options:

• Accept, enable and set as default: Uploads and enables the selected пакет, and sets it to the
default пакет for the Control Room.

• Accept and enable: Uploads and enables the пакет, but the пакет is not set as the default
пакет. Bot Creator have to specifically select non-default пакеты to use them for creating боты.

• Accept but disable: Uploads and disables the new пакет.

Choosing Reject stops the upload process.
To add a package from Bot Store, see the following video:
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7. After installation, click Administration > Packages to verify that the пакет is added.
When you add or update a пакет in the Control Room, a notification is also sent through the
Notifications icon. This notification is sent to the Control Room users who have the View package
permission. For more information, see Add or update пакет event notification.

After successfully uploading your demo package, create a бот to test the actions you just created. For
detailed step about how to create a бот, read Create a demo бот with the demo package

Create a demo бот with the demo package
Create a бот using the demo package to verify the actions that were created.
Here are the minimum prerequisites for building this demo бот:
• Access to a Control Room
• User credentials with AAE_Basic permission
• Your local host (workstation) is a registered device in the Control Room
• Ensure that the demo package A2019DemoPackageFirstnameLastname is available in the Control

Room

This task uses the following actions and components:
• Uppercase (demo package)
• Message box
• Variables overview

1. На левой панели щелкните Автоматизация.
Отобразится список доступных  и форм.

2. Click the My Task Bot icon.
3. Type MyDemoBot1 in the Name field.
4. Click Create & Edit.
5. Expand A2019DemoPackageFirstnameLastname and double Uppercase.
6. Type hello world, go be great! in all lower case letters.
7. Create the variable vMyDemoVar1.
8. Щелкните Применить.
9. Add a Message box and insert the variable vMyDemoVar1 in the Enter the message to display

field.
10. Click Apply and Save.
11. Click the Run icon.

A message box with "HELLO WORLD, GO BE GREAT!" in all upper case letters is displayed. The
custom action Uppercase converted all the letters from lower case letters to upper case letters.

The task, Change the Java file used to create the package JAR file, gives instruction on how to modify the
Uppercase action to convert all upper case letters to lower case letters.

Change the Java file used to create the package JAR file
Modify and compile the Java code used to create a package to fix issues and create new functionality.

1. Open the project "A2019DemoPakcage."
2. From inside the project, open src/main/java/

com.automationanywhere.botcommand.samples.commands/basic/Uppercase .
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3. Change the function from upper case to lower case.

Original function Updated function

String result =
 "ALL".equals(caseType) ? 
   
 sourceString.toUpperCase() :
 (sourceString
    .substring(0,
 1).toUpperCase() +
 sourceString
    .substring(1));

String result =
 "ALL".equals(caseType) ? 
   
 sourceString.toLowerCase() :
 (sourceString
    .substring(0,
 1).toUpperCase() +
 sourceString
    .substring(1));

4. Save the changes and re-compile the package.

You can now upload the changed package to the Control Room. Upload new demo package
Задачи, связанные с данной
Upload new demo package
Package management allows you to upload package updates. The new package has the same name, but a
different version number.

Upload new demo package
Package management allows you to upload package updates. The new package has the same name, but a
different version number.
You need AAE_Basic permissions to create and edit ботs.
1. From the Bots > Packages page, click the Add package icon.
2. Browse to the location of the package to add.

Packages are Java Archive (JAR) files that contain actions used to create ботs.
3. Select the package to add, and click Upload package.
4. On the Bots > Packages > Confirm package page, click Accept, enable and set as default.

You can select specific packages to be used from within a бот. Read detailed steps about managing
packages for specific боты in Update the demo бот with the updated package task.

Update the demo бот with the updated package
Update боты to use specific package versions.
• Access to the бот created in the task Create a demo бот with the demo package.
• AAE_Basic permission.

1. На левой панели щелкните Автоматизация.
Отобразится список доступных  и форм.

2. Double-click MyDemoBot1, the demo bot you created in an earlier task.
3. Click the vertical eclipses in the upper right corner and click Packages.
4. Expand the row for the package A2019DemoPackageFirstnameLastname.
5. From the drop-down list of package versions, select the Default version.

Because you added the updated package as the default version, you are selecting the new version of
the package you created.

6. Click Change Version and Save.

© 2023 Automation Anywhere. All rights reserved.     2438



    Automation Anywhere - Сборка

7. На левой панели щелкните Автоматизация.
Отобразится список доступных  и форм.

8. Double-click MyDemoBot1.
9. Click A2019DemoPackageFirstnameLastname and type HELLO WORLD, GO BE GREAT! in the

Source string field.
10. Click Apply and Save.
11. Click the Run icon.

The message box displayed by the бот displays "hello world, go be great!" This verifies that the action
from the updated package is being used.

Build and test a custom package
Для создания пользовательского пакета используйте IntelliJ, а для тестирования пакета используйте
действия Automation 360.
Complete the following tasks to create a custom package, upload the package to your Control Room, and
build a бот to test it. After you update the IntelliJ files, create directories, and create and update java
classes, you can build the custom package.
1. Build a custom package in IntelliJ

Use IntelliJ to import the Automation Anywhere SDK, create a new package, and compile a JAR file
that you can upload to your Control Room.

2. Add custom package to your Control Room

Use the compiled JAR file and upload it to the Control Room.
3. Create a бот to test the custom package

Use Automation 360 actions to create a бот to test the custom package.

Прим.:  The customer support team does not provide guidance for the code written by customers.

Прим.:  Create custom packages

Build a custom package in IntelliJ
Use Java IntelliJ to create and compile a JAR file that you can upload as a package to your Control Room in
Automation 360.
A basic understanding of JDK and Java IntelliJ is required in order to build an action package. Ensure you
have installed the following software and files:
• Java SE Development Kit 11 Downloads
• Java IDE Community edition of IntelliJ

1. Download the latest release of the Automation Anywhere Package SDK. For the latest release of the
Package SDK, see - Automation 360 Package SDK Release Notes.

2. Unzip the contents of the SDK package to any of your local directory.
3. Rename the folder from A360-package-sdk-<version number> to MetricToImperial.
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4. In IntelliJ IDEA, go to File > Open and open the project at C:\<SavedLocation>
\MetricToImperial.
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5. Open the settings.gradle file in the project root. Set the rootProject.name =
 'MetricToImperial'

6. Open the package.template file located at src > main > resources > package.template.
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7. Change the package name from A360DemoPackage to MetricToImperial.

Click the Sync button in IntelliJ to update the project.
8. Update the package name in locales json: go to src > main > resources > locales >

en_US.json.
a) Open the en_US.json file and update the required label field from A360DemoPackage to

MetricToImperial. Update the optional description.
b) Delete all other remaining lines in the en_US.json file.

9. Delete the sample packages, go to src > main > java >
com.automationanyhwere.botcommand, and delete the samples.commands and delete the
samples packages.

10. Create a new package, right-click on java folder and select New > Package. Enter the new package
name as metrictoimperial.commands.

11. Create a new Java Class, right-click on the metrictoimperial.commands package, and select
New > Java Class. Enter the name for the new class CMtoINCH:
a) Open the CMtoINCH class. Copy and paste the following code above the class definition

statement:

import static com.automationanywhere.commandsdk.model.DataType.NUMBER;
//BotCommand makes a class eligible for being considered as an action.
@BotCommand
//CommandPks adds required information to be dispalable on GUI.
@CommandPkg(
        //Unique name inside a package and label to display.
        name = "CMtoInch", label = "[[CMtoINCH.label]]",

© 2023 Automation Anywhere. All rights reserved.     2442



    Automation Anywhere - Сборка

        node_label = "[[CMtoINCH.node_label]]",  description =
 "[[CMtoINCH.description]]", icon = "ruler_icon.svg",
        //Return type information. return_type ensures only the right
 kind of variable is provided on the UI.
        return_label = "[[CMtoINCH.return_label]]", return_type =
 NUMBER, return_required = true)

b) Inside the CMtoINCH class, copy and paste the following code:

//Identify the entry point for the action. Returns a Value<String>
 because the return type is String.
@Execute
public NumberValue action(
        //Idx 1 would be displayed first, with a text box for entering
 the value.
        @Idx(index = "1", type = AttributeType.NUMBER)
        //UI labels.
        @Pkg(label = "[[CMtoINCH.CMInput.label]]")
        //Ensure that a validation error is thrown when the value is
 null.
        @NotEmpty
                Double CMInput) {
    //Internal validation, to disallow empty inputs. No null check needed
 as we have NotEmpty on CMInput.
    if ("".equals(CMInput.toString().trim()))
        throw new BotCommandException("Input of CM is required");
    Number result;
    try {
        //Conversion logic
        result = CMInput * 0.393701;
    } catch (Exception e) {
        //Throw custom error message
        throw new BotCommandException("Unable to convert " +
 CMInput.toString() + "cm to inches");
    }
    //Return NumberValue.
    return new NumberValue(result);
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    }

To import the namespaces, click the highlighted red notations and press ALT+ENTER key and select
Import which automatically imports namespaces based on the annotations and datatypes.

© 2023 Automation Anywhere. All rights reserved.     2444



    Automation Anywhere - Сборка

© 2023 Automation Anywhere. All rights reserved.     2445



    Automation Anywhere - Сборка

12. Configure en_US.json file, go to src > main > resources > locales > en_US.json and add the
following fields after the label and description values:

"CMtoINCH.label" : "cm to inches",
"CMtoINCH.node_label": "cm to inches",
"CMtoINCH.description" : "Convert centimeters to inches",
"CMtoINCH.return_label" : "Assign the Output in Inches to a Number
 Variable",
"CMtoINCH.CMInput.label" : "Centimeters to Convert to Inches"
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13. Update the CommandPkg annotation. Download icons from Github.
a) Download ruler_icon.svg from github and right-click the image and save the image as

ruler_icon.svg.
b) Download iconwhite.svg from github, right-click the image and save the image

iconwhite.svg.
c) Copy both files into the src > main > resources > icons folder.

14. Open the build.gradle in the project root. After the dependencies section, but before the last
closing tag, copy and paste the following code:

test {
   testLogging {
      exceptionFormat = 'full'
   }
   useTestNG() {}

   afterSuite { desc, result ->
      if (!desc.parent)
         println("${result.resultType} " +
               "(${result.testCount} tests, " +
               "${result.successfulTestCount} successes, " +
               "${result.failedTestCount} failures, " +
               "${result.skippedTestCount} skipped)")
   }
   maxHeapSize "3g"
}
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15. Update the version number and remove dependencies that is not required for your project from
build.gradle.

16. Create a new directory, right-click src and select New > Directory.
a) In the Name field, enter test\java, or select the test\java suggestion from the Gradle

Source Sets.
b) Create a new package, right-click the java directory and select New > Package.
c) Enter the name for the newly created package: metrictoimperial.commands.

17. Create new Java class, right-click and select New > Java Class. Enter the name for the new class
CMtoINCHTest.
Inside the CMtoINCHTest class, copy and paste the following code:

@Test
public void testCMtoINCH(){
    Double validInput = 10.00;
    Double expectedOutput = 0.393701 * validInput;
    CMtoINCH testCM = new CMtoINCH();
    Value<Double> result = testCM.action(validInput);
    Assert.assertEquals(result.get(), expectedOutput);
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}

18. Save the project File > Save All.
19. Build the package.

You can use the IntelliJ UI or the command line. If you are using the command line:
a) Open a terminal window and navigate to the MetricToImperial directory.
b) To build the project, enter the following command: gradlew.bat clean build shadowJar

A BUILD SUCCESSFUL message appears.
Sometimes a build might fail because existing files could not be automatically deleted and a system
message appears indicating the execution failed for the task: clean. If this occurs, close the explorer
windows and run the build again.

Add custom package to your Control Room
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Add custom package to your Control Room
Use the compiled JAR file and upload it as a package to your Control Room in Automation 360.
• Complete the steps in Build a custom package in IntelliJ.
• Ensure you have the following:

• Access to the Control Room.
• Credentials with AAE_Basic permission or a custom role with permissions to add packages to the

Control Room.

1. From Windows Explorer, go to C:\Users\<Username>\IdeaProjects\MetricToImperial
\build\libs and locate MetricToImperial-1.0.0.jar.

2. Log in to your Control Room as a user with permissions to add a new package.
3. Click BOTS > Packages.
4. In the All packages page, move your mouse over the plus sign and click Add package.
5. In the Add package page, click Browse and locate the MetricToImperial-1.0.0.jar file.

By default, the file is located at: C:\Users\<Username>\IdeaProjects\MetricToImperial
\build\libs.

6. Select the MetricToImperial-1.0.0.jar file and click Open.
7. Click Upload Package.

When you add a custom package to the Control Room, a notification is also sent to the Control Room
users to notify about package updates. This notification is sent to the users who have the View
package permission. For more information, see Add or update пакет event notification.

Create a бот to test the custom package
Понятия, связанные с данным
Build and test a custom package
Для создания пользовательского пакета используйте IntelliJ, а для тестирования пакета используйте
действия Automation 360.
Задачи, связанные с данной
Add custom package to your Control Room
Use the compiled JAR file and upload it as a package to your Control Room in Automation 360.
Create a бот to test the custom package
Use the actions in Automation 360 to create a бот and test the custom package.

Create a бот to test the custom package
Use the actions in Automation 360 to create a бот and test the custom package.
Ensure you have the following to build the бот:
• Access to the Control Room.
• Credentials with AAE_Basic permission or with a custom role to build a bot.
• Your workstation is a registered device in the Control Room.
• Your package MetricToImperial-1.0.0.jar is available in the Control Room.

1. Войдите в Control Room.
2. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
3. Click the Create a bot icon.
4. In the Name field, enter MetricToImperialTest.
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5. Click Create & Edit.
6. In the Actions pane, find Metric to Imperial and drag Convert centimeters to inches into the

бот flow.
a) In the CM to Convert field, enter 1.
b) Click Create variable (next to the Output field) to create a new number variable.
c) In Create Variable, enter nInchesOutput and click Create & Select.
d) Щелкните Применить.

7. In the Actions pane, find the Number package and drag the To String command below Convert
centimeters to inches.
a) In the Enter a number field, enter F2 and select nInchesOutput.
b) In the Enter number of digits after decimal field, enter 5.
c) In the Assign the output to variable field, select prompt-assignment - String from the

drop-down list.
d) Щелкните Применить.

8. From the Actions pane, drag Message box, click F2 and insert the prompt-assignment variable.
9. In the Enter the message to display field, click F2 and select the prompt-assignment variable.
10. Click Apply and Save.
11. Click Run.

The бот displays the 0.39370 message, which is a successful build.

Понятия, связанные с данным
Build and test a custom package
Для создания пользовательского пакета используйте IntelliJ, а для тестирования пакета используйте
действия Automation 360.
Задачи, связанные с данной
Build a custom package in IntelliJ
Use Java IntelliJ to create and compile a JAR file that you can upload as a package to your Control Room in
Automation 360.
Add custom package to your Control Room
Use the compiled JAR file and upload it as a package to your Control Room in Automation 360.

Using Python to parse JSON response
Use the Automation 360 Python script to execute Python functions to build a бот. Use the Python functions
to parse the JSON response from a REST Web Services GET request.
Ensure you have the following to build the бот:
• Basic understanding of Python programming language.
• Basic experience with creating Automation Anywhere боты.
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• Download and install Python 3.
download Python

Do one of the following:
• While installing the Python, make sure to select Add Python x.xx to PATH during the Python

installation.

• Add a path to the Environment variable.

1. Войдите в Control Room.
2. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
3. Click Create a bot icon.

4. In the Name field, enter PythonTutorial.
5. Click Create & Edit.

© 2023 Automation Anywhere. All rights reserved.     2452

https://www.python.org/downloads/


    Automation Anywhere - Сборка

6. In the Actions pane, click Variables to create the following new variables:
a) Name dResponse, Type > Dictionary and Subtype > String.
b) Name dRetrieveValue, Type > Dictionary and Subtype > Any.
c) Name dResponseBody, Type > String.
d) Name sFullName, Type > String.
e) Name sLocation, Type > String.
f) Name sTotalUserCount, Type > String.
g) Name nTotalUserCount, Type > Number.
h) Name nCurrentUser, Type > Number.
i) Name sCurrentUser, Type > String.
j) Name prompt-assignment, Type > String.
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7. From the Actions pane, select REST Web Services > Get method and place it under the Start of
the бот flow.
a) In the URI field, enter https://randomuser.me/api/?results=5&inc=name,email,location&nat=us.

This is a sample API that returns random user details to the calling application.
b) In the Authentication Mode drop-down list, select No Authentication.
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c) In the Assign the output to a variable drop-down list, select dResponse -Dictionary of
Strings.
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8. From the Actions pane, click String > Assign action and drag it into the canvas below the REST
Web Services action.
a) In the Select the source string variable value field, enter $dResponse{Body}$.

b) In the Select the destination string variable drop-down list, select dResponseBody -
String.
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9. From the Actions pane, click Python script > Openand drag it into the canvas below the String >
Assignaction.
a) In the Python field, select Manual input.

b) In the Enter script here field, copy and paste the following code.

import json
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def get_node_count(response):
    #parse response as json
    response_dict=json.loads(response)
    # Create list from JSON body
    response_body = response_dict['results']
    #return the count of entries in JSON body as string
    lengthasstring = str(len(response_body))
    return lengthasstring

def get_full_name(dictRequest):
    itemCount = int(dictRequest['count'])
    #parse response as json
    response_dict=json.loads(dictRequest['response'])
    # Create list from JSON body
    response_body = response_dict['results']
    #Extract values to return
    return response_body[itemCount]['name']['first'] + " " +
 response_body[itemCount]['name']['last'] 

def get_location(dictRequest):
    itemCount = int(dictRequest['count'])
    #parse response as json
    response_dict=json.loads(dictRequest['response'])
    # Create list from JSON body
    response_body = response_dict['results']
    #Extract values to return
    return response_body[itemCount]['location']['city'] + ", " +
 response_body[itemCount]['location']['state']

c) In the Python runtime version field, retain the default value as 3.
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10. From the Actions pane, click Python script > Execute function and drag it into the canvas below
the Python script > Open action.
a) In the Python session field, retain Default.
b) In the Enter the name of function to be executed field, enter get_node_count.
c) In the Arguments to the function drop-down list, select dResponseBody - String.

d) In the Assign the output to a variable drop-down list, select sTotalUserCount - String.
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11. From the Actions pane, click Dictionary > Put and drag it into the canvas below the Python script
> Open action.
a) In the Dictionary variable field, select dRetrieveValue -Dictionary.
b) In the Associate to this key field, enter response.
c) In the New value drop-down list, select dResponseBody - String.
d) In the Assign previous value to a variable drop-down list, select prompt-assignment -

String.
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12. From the Actions pane, click String > To number and drag it into the canvas below the Dictionary
> Put action.
a) In the Enter the string field, enter $sTotalUserCount$.
b) In the Assign the output to a variable drop-down list, select nTotalUserCount - Number.
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13. From the Actions pane, click Loop > Loop.
a) In the Loop Type > Iterator, select For n times from the drop-down list.
b) In the times field, enter $nTotalUserCount$.
c) In the Assign the current value to a variable drop-down list, select nCurrentUser -

Number.
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14. From the Actions pane, click Number, select Decrement and place it inside the Loop action.
a) In the Enter number field, enter $nCurrentUser$.
b) In the Enter decrement value field, enter 1.
c) In the Assign output to a variable drop-down list, select nCurrentUser - Number.

15. From the Actions pane, click Number, select To string and place it inside of the Loop action, below
Number > Decrement.
a) In the Enter a number field, enter $nCurrentUser$.
b) In the Enter number of digits after decimal field, enter 0.
c) In the Assign output to a variable drop-down list, select sCurrentUser - String.
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16. From the Action pane, click Dictionary > Put and place it inside of the Loop action.
a) In the Dictionary variable field, select dRetrieveValue -Dictionary.
b) In the Associate to this key field, enter count.
c) In the New value drop-down list, select sCurrentUser - String.
d) In the Assign previous value to a variable drop-down list, select prompt-assignment -

String.
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17. From the Actions pane, click Python script > Execute function and place it inside of the Loop
action.
a) In the Python session field, retain Default.
b) In the Enter the name of function to be executed field, enter get_full_name.
c) In the Arguments to the function drop-down list, select dRetrieveValue - Dictionary.
d) In the Assign the output to a variable drop-down list, select sFullName - String.
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18. From the Actions pane, click Python script > Execute function and place it inside of the Loop
action.
a) In the Python session field, retain Default.
b) In the Enter the name of function to be executed field, enter get_location.
c) In the Arguments to the function drop-down list, select dRetrieveValue - Dictionary.
d) In the Assign the output to a variable drop-down list, select sLocation - String.
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19. From the Actions pane, click Message box and place it inside of the Loop action.
a) In the Enter the message to display field, enter the following:

Full Name: $sFullName$ Location: $sLocation$

b) Select Close message box after > Seconds, enter 5.

20. From the Actions pane, click Python script > Close and place it outside of the Loop action.
a) In the Python session field, retain Default.

21. Click Save to save your бот, and then click Run.
The бот runs, displaying five full user names with locations for approximately 5 seconds each before
completing its successful execution.

If you get a Bot Error message, see the following sections for a solution: Getting Bot Error while
executing Python Script/Function (A-People login required), Getting Bot Error or True value in message box while
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executing Python Script (A-People login required), or An unexpected error occurred while executing Python Script
command; Error code: bot.execution.error (A-People login required).

Use JavaScript to build a бот to take user input
Use the JavaScript actions Automation 360 to execute JavaScript functions to build a бот. Use the actions
to create a бот that takes user input and provides the appropriate output.
Ensure you have the following to build the бот:
• Basic understanding of JavaScript programming language.
• Basic experience with creating Automation Anywhere боты.

1. Войдите в Control Room.
2. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
3. Click Create a bot icon.
4. In the Name field, enter Hello User.
5. Click Create & Edit.
6. In the Actions pane, click Variables to create the following new variables:

a) Name lInputList, Type > List and Subtype > String.
b) Name sInputName, Type > String.
c) Name sOutput, Type > String.

7. From the Actions pane, click Prompt > For value:
a) In the Prompt window capture field, enter Enter your name here.
b) In the Prompt message field, enter Please enter your name here.
c) In the Assign the output to a variable drop-down list, select sInputName - String.

8. From the Actions pane, click List > Add item:
a) In the List variable drop-down list, select lInputList - List.
b) In the Item to be added drop-down list, select sInputName - String.
c) In the Add item field, select To end of list.

9. Create a new JavaScript file.
a) Open a notepad, and copy and paste the following code:

function response(str){
return "Hello "+ str
} 

b) Save the file in your desktop as Salutation.js, and select Save as type: as All Files.

10. From the Actions pane, click JavaScript > Open:
a) In the JavaScript session field, leave as Default.
b) In JavaScript > Import existing file, for the JavaScript file field, select Desktop file.
c) Click Browse and select the Salutation.js file from your desktop or where you saved the file.
d) In the Assign the output to a variable drop-down list, select sOutput - String.
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11. From the Actions pane, click JavaScript > Run JavaScript:
a) In the Enter name of the function to be executed field, enter response.
b) In the Parameters drop-down list, select lInputList - List.

12. From the Actions pane, click Message box:
a) In the Enter the message to display field, enter $sOutput$.

13. Click Save to save your бот, and then click Run.
14. When the бот prompts to enter a name, enter the name and click OK.

A message from the бот appears: Hello <User>.

Бот developer recommendations
Automation Anywhere provides a flexible platform for бот and package development. The information in
this topic provide guidelines and recommendations on how to structure and develop robust and reusable
боты and packages.

Bot Store submissions checklist
Use the checklist to ensure that your Automation 360 Bot Store submission is correctly created, processed,
and accepted. If you do not follow requirements listed in the checklist, your submission will be rejected
and will not be published on the Bot Store page.
Use this checklist from the developer portal: Automation 360 bot submission checklist.

Building reusable боты
Review the guidelines to gain a better understanding of how to develop боты or subtasks for reusability,
from designing and creating through reusing.

Define prerequisites, input, output, and
variables

When you build боты for reusability, define the
following:
• Document all necessary prerequisites on how to

use your бот either on its own or as a subtask.
• When creating your боты, define values as

input, output, or local. Input and output
variables are used when your бот is designed to
be used as a subtask, allowing it to receive and
pass back values to or from another calling бот.

• Provide meaningful variable descriptions when
defining input and output variables so that other
developers know how to interact with your
subtask.

• Adhere to an established standard for variable
naming guidelines. Review the Automation
Anywhere user-defined variables for variable
naming guidelines. Your variables (user-defined)

Follow single-responsibility principle Боты developed for reusability should follow
the single - responsibility principle which states
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that each subtask or component should have
responsibility over a single part of the functionality
of the overall бот and that responsibility should
be entirely encapsulated by that subtask or
component.
Other examples of single-responsibility:
• A subtask that processes a single transaction,

but can be called multiple times for each
transaction on a list.

• A subtask that collects screen display data on
a single page of a website, but can be called
multiple times as a бот goes through pagination.

Bot design considerations Consider the following patterns based on which
templates must be developed for use:
1. Master, Main, and Sub боты

• Master бот: This бот is called directly to
begin the process, through mechanisms
including scheduling through the Control
Room or API call. Include the following
major process steps in the TRY section:
a. Initial setup for the process.
b. Validation that the setup was

successful. For example, check whether
all required files and folders exist or
initial variable values are populated as
required.

c. Run the desktop PRE-PROCESS
CLEANUP.

d. Call the main бот to run the business
logic of the process.

In the FINALLY section, run the desktop
POST-PROCESS CLEANUP.

• Main бот: This бот calls the sub боты as
required to run the business logic of the
process. Include the following major process
steps in the TRY section:
a. Validation of any input. For example,

input variable values from the master
бот.

b. Execution of sub боты.
c. Validation of any output.
d. Ensure population of any output

variable values based on the execution
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of main бот, to return to the master
бот.

In the CATCH section, log the error, and
ensure population of any output variable
values, for example, oStrResult to pass
back to the master бот.

• Sub боты
• A sub бот is called by the master бот or

main бот to run the actual business logic
required for the automation. They are
also referred to as helper tasks or utility
tasks because their only purpose is to
assist the calling task.

• Use output variables to return a result
indicator to the calling бот either main,
or another sub бот. For example,
outStrResult. The value contains an
error message if the processing was not
successful due to an error or exception
that had occurred.

2. Main and Sub боты: This pattern includes the
master and the main бот in an single main бот.
The design pattern of the Sub бот is similar to
the design pattern explained above.

Opening and closing applications Any applications, files, or windows that a бот or
subtask opens must be closed by the same бот or
subtask.
• For example, when a бот opens Microsoft Excel

to perform a spreadsheet operation, verify that
the spreadsheet and Excel are closed when the
бот finishes processing.

• Close applications when the бот execution is
successful or unsuccessful.

• Use the Finally block of the Try/Catch/
Finally operation to ensure applications
are closed regardless of success of the task
processing.

• In the case that applications do not respond
during testing, consider using the command
prompt to forcefully close (kill) the applications.
For example, to forcefully close power point, the
command-line operation would be:

Taskkill /IM powerpnt.exe /F

Error handling After completing the task, verify that the бот
successfully handles any failure or exceptions.
• Each task or subtask must handle its own errors.
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• An unhandled exception in a subtask can cause
issues in a parent task.

• Use Try/Catch/Finally blocks at the root level
of every бот.

• Use Try/Catch blocks inside of a loop if you
want to try an operation multiple times before
reporting a failure.

Event or exception handling Other than action errors that are captured by
Try/Catch, you must perform code checks for
other processes such as events or exceptions. If a
certain process condition occurs, notify or log these
conditions for additional analysis.
• Develop a configurable event handler TaskBot

that minimizes the requirement for code changes
if the actions change. For example, maintain
an XML file that contains a definition of all
the possible events or exceptions and any
notification requirements when those events or
exceptions occur.

• In the code, when such events or exceptions
occur, write the information to an event log.
You can also add memory usages and capture a
screenshot.

• Run the event handler TaskBot to process
the event or exception. For example, issue a
notification using parameters such as email
recipient, CC recipient, or subject from the XML
file.

• If the notification requirements vary for
each environment, or change over time, the
configuration file can be updated without having
to change the code.

Running боты on other computers When designing a бот, enable it so it runs on
computers other than the computer on which a бот
was created.
• Use variables for local file paths, network

shares, or window titles so that your бот can
successfully run from other machines.

• Consider using global values for environment
markers or network shares that multiple боты
need access to.

• Use wildcard characters for window titles where
appropriate to enable боты to run regardless
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of specific environment or version of the target
application. For example, instead of using

Salesforce - Professional Edition
 - Internet Explorer

use the following:

Salesforce - * - Internet Explorer

Using prompts, message boxes, and infinite
loops

Prompts and message box actions stop the боты
from running when waiting for a user input. Unless
a user input is required, design the боты without
using prompt statements.
• When using loops, ensure all loops have a

definite end by clearly defining their number of
iterations or specifying where break loop actions
need to exist.

• If your бот is intended to run as an unattended
бот, remove or disable any prompts or message
box actions.

• If you are building боты for an attended
automation scenario, message boxes and
prompts are often reasonable or required for
боты to run as expected. Use message boxes to
display different variables, such as, responses,
outputs, or values.

Storing sensitive data in the Credential Vault The Control Room includes the Credential Vault that
can be used to store sensitive information, such as
user names, passwords, API keys, and tokens.
• When building a бот, create a locker in the

Control Room using the Credential Vault to store
credentials and retrieve them as required by
referencing the credential and the attribute.
This allows users to create боты that consume
APIs or perform logins without the need for
бот builders to directly hard-code the required
credentials within a бот.

• Do not hard-code sensitive credentials into a
бот, or a subtask, because hard-coded storage
in a бот introduces a security risk.

• When Credential Vault values are required to
be used in a бот, verify that all ячейка names
and credentials are clearly defined in the bot
documentation. If required, include details on
how to obtain credentials, for example, an API
key or a token.

Testing independent tasks When creating боты for reusability, design them
in a way that they can be tested independently of
other subtasks.
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• Practice the test-driven development (TDD)
approach: When adding a new бот, or a new
feature in an application, write a test case for it.

• In a test case, define the specific function that
validates that feature or functionality.

• For single-responsibility principle and reusability,
create many smaller tasks that can be tested
independently.

Using comments and steps Comments enable developers to provide
descriptions within their боты so that бот other
бот developers can better understand what each
section, block of code, or subtask is designed for.
Include clear comments to allow developers to
understand the purpose of the function of a given
code block.
• When боты are submitted to the Bot Store,

commenting demonstrates how to customize the
бот.

• Using comments makes code maintenance
easier because section descriptions help identify
where changes might be required to enable
developers to work towards quicker issue
resolution

• Comments on боты that are a work in progress
can be helpful when creating placeholders
for future work. Consider using a TODO
command as a reminder to add logic to the бот,
but update the comments when the work is
completed.

• Automation 360 includes the Шаг action, which
provides the capability to organize the code into
logical groupings to improve readability and the
flow.

• Create an outline of the major objectives of your
бот by using empty, labeled step actions. When
that is completed, go back to each step and
complete the logic for the step.

Creating logging files Identifying problems without logs can be difficult
when боты are running unattended on any number
of Bot Runner. Software developers, support teams,
and бот owners rely on logs to understand where
their automations have issues and how to diagnose
problems. Боты must log errors to get error details.
• Use error handling and screen captures to better

understand when a бот or subtask encounters
an error.

• Use the A2019 Bot Store template that contains
basic error handling, logging, and snapshot
capabilities with the customizable root logging
location for maintaining older log files.
Bot Store bot template
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• If required, create additional logging files and
include a full audit history of everything a бот
or subtask has done. The additional log files
can include audit, debug, and performance
information about the бот, as well as the
following:
• Main бот start and end time.
• Subtask start and end time.
• The completion time of specific milestones

defined within the бот.
• Number of transactions received in an input

file.
• Number of successfully processed or failed

transactions.

See also:  Best practices: Building reusable and secure Automation 360 bots and packages

Задачи, связанные с данной
Using Цикл action
Use the Цикл action to repeatedly run a sequence of actions for a specific number of times or until a
condition is met.
Ссылки, связанные с данной
Your variables (user-defined)
Users and some actions create user-defined variables to temporarily hold values. Use this kind of variable
to input values into an action (window title, login credential, or file path) or to accept the output of an
action (values read from a file or a Boolean return).
Приложение пакет
Use the Open Program/File action in the Приложение пакет to launch an application or a file. This
action supports .exe, .bat, script files, or shortcut paths.
Обработчик ошибок пакет
If a бот encounters an error due to an abnormal condition or exceptions during execution, the normal
execution of the бот is hindered, and the бот fails to complete the task. The Обработчик ошибок пакет
contains actions that enable you to easily handle exceptions a бот encounters and transfers control to the
other actions within that бот.
Шаг пакет
The Шаг пакет groups various actions together and runs them in a specific order. You can provide a
relevant name for a step to identify the operation performed by the actions included in that step.
Запрос пакет
Use the Запрос пакет to accept an input value, a yes/no response, or to open a file or folder.
Message box package
Use the Message box action from the Message box package to insert a message box that shows a
message when the task runs. For example, you can insert a Message Box action to follow a web form so
that the action displays the message: Web Form Filled and Complete.

Building reusable пакеты
Review the guidelines to understand how to build пакеты for reusability.

Know your incoming data When setting fields that your action пакет requires
from the user, provide specifics in setting the
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attribute type to limit the kinds of data that your
пакет receives.
• Limit the input to reduce the burden of checks

that have to be done when the package is
received.

• Javadoc includes 34 defined attribute types,
so review those when you build your пакет to
select the appropriate field types.

• Set your пакет so that it takes a stored value.
For example, on behalf of the бот, your пакет
is making API calls, verify that the AttributeType
of the action input field for the API key or
a token is set to credential. This way users
are encouraged to use a value stored in the
Credential Vault for sensitive input data that the
пакет requires.

Use labels appropriately In the CommandPkg annotation, use different labels,
node_labels, and descriptions appropriately.
• Use these labels as short descriptions of your

action and use only a few words to describe an
action.

• Replicate the same naming style as it is
presented in the default Action пакеты.

• Each action is a child element of a пакет, and
the action label is displayed along with the пакет
icon in the Actions pane. Use short names to
describe each action.

• Document an expected input format for certain
fields. Use the parameter description for the
@Pkg annotation. This allows пакет developers
to review the format, requirement, or data that
must be used for a specific input field. Пример.

@Pkg(label = "Start Date",
 description="Date Format as MM/
DD/YYYY"

Unit test your components During the пакет development, create unit tests to
validate that each component and the action of the
пакет is working as expected.
• Validate the behavior of the individual test unit,

a single class, or a single action, to ensure that it
is functioning as expected.

• Review and document any feature or
functionality defects at early stages of the
development process.

Handling errors Include the error handling in the бот logic to ensure
that all errors are handled gracefully. If an error
is not handled, it could prevent a бот runner from
executing other tasks.

© 2023 Automation Anywhere. All rights reserved.     2476



    Automation Anywhere - Сборка

• Create meaningful error messages that can help
бот consumers with error resolutions.

• As a пакет developer, keep in mind these
recommendations:
• Use Try/Catch block to accommodate for an

error.
• Use a multi-catch block to find specific errors,

and use the BotCommandException to
return customized error messages. Пример.

//create array of 3 items
int[] myIntArray = new int[]{1,
 0, 7};
try {
    //print 4th item in array
   
 System.out.println(myIntArray[3]);
    //Perform operation on
 first and second items in
 array
    int result =
 myIntArray[0] / myIntArray[1];
} catch
 (ArrayIndexOutOfBoundsException
 e) {
    //Throw custom message for
 IndexOutofBounds
    throw new
 BotCommandException("The
 array does have the number of
 expected items.");
} catch (ArithmeticException e)
 {
    //Throw custom message on
 Atithmetic Exception
    throw new
 BotCommandException("Math
 Operation Error with " +
 Integer.toString(myIntArray[0])
 + " and " +
 Integer.toString(myIntArray[1]));
}

Follow single-responsibility principle A пакет is a collection of actions. Each action within
a пакет must have a single responsibility and that
responsibility must be encapsulated by that action.
• Following the single-responsibility principle

helps your пакет consumers to implement it
easily, simplifies testing, and avoids unnecessary
modifications.

• The actions that you offer allow пакет
consumers to customize the way they use your
пакет within their боты, and can help their боты
be as efficient as possible.

Provide examples When submitting пакеты to the Bot Store include a
demo бот that demonstrates the use of the пакет.
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• Use the Automation 360 actions and allow пакет
consumers to use these actions to expend their
бот capabilities.

• Always provide sample боты with descriptions to
help your пакет consumers with the knowledge
they require to understand its proper use.

See also:  Best practices: Building reusable and secure Automation 360 bots and packages

Ссылки, связанные с данной
Building reusable боты
Review the guidelines to gain a better understanding of how to develop боты or subtasks for reusability,
from designing and creating through reusing.

Troubleshooting and debugging
Troubleshooting and debugging information.

Troubleshoot bot run issue
Issue: I'm unable to deploy a bot because I get the following – Unexpected error setting up a new user
session.

Cause: Most often, this error is caused by invalid device
credentials.

Solution: Confirm the device is registered and connected.
1. Select Devices > My devices from the

Automation Anywhere web interface.
2. Confim that the Status column shows

Connected for the relevant device.

Confirm that the device username and password
are correct.
1. Select the profile icon on the Automation

Anywhere web interface and select Edit
profle.

2. Verify the device username.
Depending on how the device is configured
within the network, you might need to prepend
it with the domain name. For example,
domainname\firstname.lastname.

3. Verify the device password.

© 2023 Automation Anywhere. All rights reserved.     2478

https://developer.automationanywhere.com/learn/bot-developer-journey/best-practices-building-reusable-and-secure-automation-360-bots-and-packages


    Automation Anywhere - Сборка

Debugger tool
The Automation Anywhere Debugger tool helps you to identify and troubleshoot any issues during бот
running process.
The Debugger tool is available from:
• Assistant utility
• Bot editor

Open the бот from the Automation page and invoke the Debugger. You can add, update or delete actions
and variables within a бот when Debugger is invoked from the Bot editor.
The Bot editor canvas provides the following breakpoints controls that you can use for the Debugger tool:
• To insert a breakpoint, click the vertical ellipses and select Enable breakpoint.
• To disable a breakpoint, click the vertical ellipses and select Disable breakpoint. The breakpoint

becomes inactive.
• To clear all breakpoints, click the Clear all breakpoints icon.

The Debugger tool provides the following controls:
• Start debugger: Use to start the debugging process.
• Step Over: Use to move one action at a time.
• Stop: Use to stop the debugging process.
• Step Out: Use to jump to the next breakpoint directly. The Debugger tool skips to the next action and

pauses. When the debugging is in process, the Start debugger icon changes to Step Out.

Watched variables
You can use Watched variables to watch the values of the respective variable during бот execution. By
default, the Watched variables list is empty. With a single click, you can add used variables in a бот.
These variables are displayed in a pop-up window where you can select or deselect, one or more variables,
from the list.
You can add variables used in a бот to the Watched variables list using either of these methods:
• Select the Click here to add used variables link under No watched variables to add all of the

used variables in a бот with one click.
•

Click the x ( ) icon next to Watched variables to add or remove variables manually.
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The following pop-up is displayed when you click the x icon to add or remove variables manually:

When a бот updates the variables, the values of those variables are updated dynamically in the Watched
variables list. This provides a current status of a бот run at each action, and helps fix any бот-related
errors at an early stage from the Debugger tool.

The following pop-up window displays the list of Watched variables:
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Прим.:
• You can run the Debugger tool using the Flow and List views. However, we recommend that you use

the List view to see which action is running.
• You cannot edit actions during the debugging process.
• If you rename a variable that is in the Watched variables list, then you must re-add it for it to appear

under Watched Variables list.
• Debugging of child боты from the parent бот is currently not supported.

Bot Agent log files
Various types of information about the Bot Agent are captured in different log files. You can analyze these
log files when the Bot Agent or a бот encounters an error and identify the root cause for that error.

Обзор

The Bot Agent log files enable you to perform these actions:
• Determine whether a бот ran successfully
• Identify issues that resulted in a бот failure
• Determine if the device is properly connected with the Control Room

Log file locations

The Bot Agent log files are available at C:\ProgramData\AutomationAnywhere\BotRunner\Logs
on your device. The following files are available at this location:

Bot_Launcher Captures information about the execution of a бот
such as the operations performed, events triggered,
and errors encountered by the бот.
The filename now includes the name of the user
running the бот on the Bot Runner. For a multi-user
session machine, there will be a бот launcher log
per user.

Node_Manager Captures information about when a бот is run
from the Control Room and communication details
between a Bot Runner and the Control Room.

Log file configuration

To configure the different types of log files that can be collected from the devices connected to the Control
Room, see Configure log collection.
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Оцифровка
Automation Anywhere offers several web-based intelligent document processing solutions that extract
semi-structured data from documents and convert it into structured data, which can be used by Robotic
Process Automation (RPA) боты for automation of business processes.

Обзор

Typically, RPA боты can automate only those tasks that involve processing structured data. As a result,
about 80% of a business's data remains inaccessible to RPA боты as "dark data." This dark data is made
accessible to RPA боты by cognitive automation, which combines the technologies of intelligent document
processing and RPA. With cognitive automation, semi-structured data is extracted from documents such as
invoices, and converted into structured data, so RPA боты can subsequently use this structured data for
automating business processes.

Learn more about the Automation Anywhere intelligent document processing solutions:

Document Automation Document Automation — это новое Cloud решение
для интеллектуальной обработки документов,
которое бизнес-пользователи могут настроить
для автоматического чтения и быстрой
обработки документов с использованием
предварительно обученных моделей и обратной
связи при валидации.
Document Automation on page 2568

Automation 360 IQ Bot In Automation 360 IQ Bot, users configure
templates and train боты to extract data from a
variety of documents. Automation 360 IQ Bot is
available for on-premises and cloud installations,
and offers users a wide range of tools to customize
and optimize document processing, including the
following:

© 2023 Automation Anywhere. All rights reserved.     2482



    Automation Anywhere - Оцифровка

• Пакеты to create models for classifying
documents by category and to enhance the
quality of documents or images for better
extraction

• Standard form models for extracting data from
documents that have minimal or no variation in
their layout

• Support for Optical Character Recognition (OCR)
engines to improve the accuracy of the extracted
data

Automation 360 IQ Bot on page 2488
IQ Bot 11.3.x This early version of IQ Bot supports Enterprise

11 customers. It is available for on-premise
installations only.
IQ Bot 11.3.x

Community Edition Версия Community Edition предлагает
пользователям ограниченные функции решений
для обработке документов Document Automation
и Automation 360 IQ Bot. This version is available
to users for free.
Community Edition on page 2483

Community Edition
Версия Community Edition предлагает пользователям ограниченные функции решений для обработке
документов Document Automation и Automation 360 IQ Bot. This version is available to users for free.
Пользователям не требуется приобретать лицензию, и нет ограничений по времени. Однако
существуют следующие функциональные ограничения:
• Для одного пользователя можно создать не более пяти обучаемых экземпляров.
• Вы не можете удалить обучаемый экземпляр.
• Из списка обучаемых экземпляров вам доступны для просмотра и доступа только созданные вами

обучаемые экземпляры и данные.
• You cannot integrate a Community Edition version of Document Automation with an Automation 360 IQ

Bot environment.
• Google Document AI and Standard forms are not supported.

Начните с Community Edition

Чтобы начать использовать Community Edition, выполните указанные ниже действия.
1. Зарегистрируйтесь и войдите в Community Edition:

Выполните шаги 1 и 2 Начните с Community Edition on page 1028.
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2. Установите Bot Agent и задайте учетные данные пользовательского устройства.
a. Перейдите в раздел Управление > Устройства и щелкните Подключить локальное

устройство. Выполните инструкции мастера, чтобы подключить Control Room к своему
устройству.

b. Щелкните Обновить, чтобы проверить подключение устройства.
c. Щелкните свое имя пользователя. Перейдите в раздел Мои настройки > Устройства >

Учетные данные. Щелкните Редактировать, чтобы указать имя пользователя и пароль
устройства.

3. Перейдите в раздел Управление > Обучаемые экземпляры и выберите версию IQ Bot,
чтобы приступить к созданию обучаемых экземпляров:
• Вариант 1. Щелкните Создать экземпляр для обучения.

Создайте обучаемые экземпляры для извлечения данных из счетов-фактур в Document
Automation. Создание обучаемого экземпляра в Community Edition on page 2484

• Вариант 2. Щелкните Обучить для других документов.
Создайте обучаемые экземпляры для извлечения данных из документов других типов с
помощью Automation 360 IQ Bot: Краткое руководство пользователя по IQ Bot Community
Edition

Создание обучаемого экземпляра в Community Edition
Создайте обучаемый экземпляр, чтобы начать обработку документов. В Community Edition вы можете
извлекать данные из счетов-фактур на английском языке с использованием поставщика ABBYY OCR.
1. From the Control Room home page, navigate to Manage > Learning Instances > Create

Learning Instance.
2. Enter a name and description for the learning instance.

Document Automation does not allow duplicate learning instance names, so the name you provide
must be unique.

3. Щелкните Вперед.
We recommend that you open a sample document side by side with the Control Room window as you
configure the form and table fields.

Note:
• A form field is a type of field that occurs only once in a document.
• A table field is a type of field that reoccurs throughout a document, typically in the form of a table.

4. Configure the form and table fields for extraction.
Document Automation offers a standard set of form and table fields, many of which are not initially
visible. You can search for a field by field name, field label, or data type.
To see the full list of fields, click Show unused fields. See the following video for a demonstration:
Click a field to open the fields editor. You can edit most attributes of a field. You cannot edit the name
and default aliases. Document Automation assigns default aliases, which are hardcoded keywords, to
standard fields to help with extraction. You cannot modify or delete default aliases, but you can add
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aliases in the Custom aliases field. See the following video for a demonstration of creating a custom
alias:

Note:  Custom fields are not available for learning instances that use the Google Document AI
provider.

Mouse over the menu icon to the right of a field to access the up/down arrows. Use the arrows to
rearrange the order of the fields for a more efficient manual validation. The order of the fields does
not impact extraction.
To learn more about the other field attributes, review the table in the next step.

5. To add a field, click Add a field and complete the following fields:
Вариант Описание

Имя поля Enter a field name that begins with an alphabetical character (A-Z or a-z).
In standard fields, the field name is hardcoded and cannot be changed.

Метка поля Enter a user-friendly name to help validators.
For example, you can rename Organization tax number to a localized
name, such as VAT number.
The field label does not affect extraction.

Достоверность Set a threshold to reduce potential false positives.
At the time of processing, the Document Automation engine assigns a score to
each field in a document to indicate the certainty that the data was correctly
extracted. If the document contains fields with a score that is lower than the
confidence threshold, the document is sent to the validation queue.
If you enter a high confidence threshold, more documents will be sent to the
validation queue. If you enter a low confidence threshold, fewer documents will
be sent to the validation queue.
Supports values from zero to 100.

Тип данных Choose from Address*, Text, Number, and Date.
If the data in the field does not match the data type, the document is sent to
the validation queue.
Document Automation supports date and number format variations.
* If you are configuring a learning instance with a user-defined document type,
the form fields include the address data type, which extracts the entire structure
of an address.

Требуется Select one of the following:
• Required: Field cannot be empty.
• Необязательно. Field can be empty or not exist in the document.

Default aliases No action is necessary for this field. Document Automation assigns default
aliases, which are hardcoded keywords, to standard fields to help with
extraction.
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Вариант Описание

Пользовательские
псевдонимы

Additional keywords to help Document Automation locate the field. For example,
add country or region-specific names for fields such as VAT number as an alias
to an Organization tax number custom field.

Note:  Custom aliases must be unique. They cannot duplicate the default alias
of another field. Exception: Form fields can have duplicate custom aliases as
the table fields and vice versa.

Правила
проверки

Depending on data type, create rules using patterns, formulas, lists, and
statements such as starts or ends with.
Formula validation on page 2595 | Pattern validation on page 2598

6. Click Create.

Загрузите документы в обучаемый экземпляр, исправьте ошибки валидации и проверьте
извлеченные данные: Обработка документов в Community Edition on page 2486

Обработка документов в Community Edition
Загрузите образцы счетов-фактур для обучения обучаемого экземпляра, валидации извлеченных
данных и исправления ошибок валидации.
• Если вы еще не сделали этого, Создание обучаемого экземпляра в Community Edition on page 2484
• Убедитесь, что размер каждого файла не превышает 2 МБ.
• Убедитесь, что образцы счетов-фактур относятся к следующим поддерживаемым типам

документов:
• PDF
• JPG
• JPEG
• PNG
• TIF
• TIFF
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Загрузите образцы счетов-фактур в обучаемый экземпляр, чтобы проверить возможности
извлечения данных из обучаемого экземпляра. Если документ требует ручной валидации, система
отправляет его в Валидатор, в котором вы должны вручную ввести правильные данные.
1. Загрузите документы в обучаемый экземпляр:

Note:  Community Edition может обрабатывать не более пяти документов одновременно. Для
загрузки другого документа необходимо дождаться успешного завершения его обработки (и,
при необходимости, валидации).

a) Щелкните Обработка документов.
b) В окне Документы процесса щелкните Обзор, чтобы выбрать файлы для загрузки.
c) В поле Загрузить данные в введите путь к файлу, по которому извлеченные данные

будут извлечены в файл CSV.
d) Щелкните Обработка документов.

The Bot Runner window appears. The window disappears when the documents are done
processing. Refresh the Learning instances table to see the updated metrics.

Если рядом со ссылкой Проверить документы имеется значение, то необходимо вручную
проверить поля с ошибками. В противном случае перейдите к шагу 2b, чтобы просмотреть
извлеченные данные.
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2. Fix the validation errors
a) Click Validate documents.

The AARI Task Manager opens in a new tab, with the first failed document in queue. For an
introduction to the Validator user interface, see Using the AARI Task Manager Validator for Document
Automation on page 2608.

b) Review each field to verify the data type and extracted value.
Document Automation supports the following data types: text, number, time, and check box
Alternatively, from the drop-down list on the right panel, you can select Show fields that need
validation.

Note:  When documents are awaiting validation, if you edit the learning instance, click
Reprocess to reattempt extraction.
Reprocessing documents does not affect the uploaded documents metric.

c) Update the fields with errors.
Click the field or draw a box around the values that you want to extract.
For Automation Anywhere pre-trained models, you can configure the learning instance to extract
specific values in a field and ignore others. Подробнее см. в разделе Using validation feedback to
extract specific values in a table on page 2588.

• To skip a document without correcting errors, click Skip to proceed to the next document in
the validation queue.

• To remove a document that cannot be processed, click Mark as Invalid.

d) After you make the necessary corrections, click Submit so that the document can finish
processing.
The next document in queue appears. When all the documents are corrected, the system displays
a message stating that no more tasks are available.

e) Close the tab to return to the Learning Instances page.

3. Verify the output results:
a) Open the file in the Success folder that contains the extracted data and review the results to

ensure that it matches your use case.
b) Optional: Review the Learning Instance dashboard.

The dashboard displays the total number of uploaded documents and the number of documents
pending validation.

Поздравляем! Теперь вы успешно обработали свои первые документы в версии Community Edition
Document Automation.

Automation 360 IQ Bot
Automate document-centric business processes, end to end, by using IQ Bot, a web-based, Cloud-native
intelligent document processing solution that can read and process complex documents and email. This
solution combines RPA with AI techniques to extract and classify semi-structured and unstructured data.
Automation 360 IQ Bot is a hybrid solution for On-Premises and Cloud deployments.
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Note:  From Build 4695 (A2019.13), Automation 360 IQ Bot has feature parity with IQ Bot Version
11.3.4.2 and some features from Version 11.3.5. For feature parity information between Automation 360
IQ Bot and the corresponding IQ Bot 11.x versions, see Матрица сравнения функций Automation 360 IQ
Bot on page 740.

Обзор

The technologies of IQ Bot and RPA together constitute cognitive automation. With cognitive automation,
IQ Bot extracts semi-structured and unstructured data and converts it into structured data, and RPA боты
subsequently use this structured data for automating business processes.
IQ Bot works by using learning instances. A learning instance is a structure that holds information such
as document type, language, and fields to be extracted from tables and forms. A learning instance also
includes боты that are trained to extract data from documents.
IQ Bot is also supported by RPA боты that are built for functions such as training the Classifier, sharpening
document resolution, and downloading the extracted data.
After the боты in a learning instance are trained and the necessary RPA боты are built, a learning instance
is set to production mode. After that, IQ Bot can start processing documents automatically, through the
following steps:
1. Retrieves documents from a source, such as attachments in incoming email
2. Improves document quality
3. Classifies documents into groups
4. Extracts data
5. Either downloads the extracted data or first sends the document for manual validation and then

downloads the data

Types of IQ Bot users

In many organizations, different types of users perform specific tasks within their product area to create,
configure, and publish a learning instance and the supporting assets. To learn more about the user types,
required licenses, roles, and permissions, and the assigned product areas, see IQ Bot user personas on page
2493.
The following diagram demonstrates the sequence of how a learning instance and supporting assets are
built, as well as which user performs which task.
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Get started with learning instances

Perform the following these steps to create a learning instance, train боты, and set the боты to
production:
• Using Automation 360 IQ Bot On-Premises on page 2491
• Using Automation 360 IQ Bot Cloud on page 2492
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Build RPA боты for IQ Bot

The following links guide you in configuring RPA боты to support IQ Bot functions.
• Use the IQ Bot Classifier пакет to improve classification and prevent invalid documents from being

uploaded to a learning instance.
Train the classifier | Classify documents

• Use the IQ Bot Pre-processor пакет to prepare documents and extract data before processing.
Using EnhanceImage action on page 1665 | Using ConvertImageToPDF action on page 1663

• After sending a learning instance to production, configure a бот with the Process documents action
from the IQ Bot Extraction пакет: IQ Bot Extraction пакет on page 1668

• Download extracted data

Ресурсы

For more information, review the courses in the IQ Bot Developer learning trail: IQ Bot Developer Training
(A-People login required).
You can also search for the following courses in Automation Anywhere University: RPA Training and
Certification (A-People login required):
• Intelligent Document Processing with IQ Bot
• Unleash Your Intelligent Bots: Develop Cognitive Bots Driven by AI & Machine Learning (IQ Bot)

Related concepts
Install and update Automation 360 IQ Bot on page 1073
This collection of topics guide you through the process of installing or setting up Automation 360 IQ Bot
On-Premises and Cloud.
Languages supported in Automation 360 IQ Bot on page 2497
Up to 31 languages are supported in IQ Bot. You can also access up to 190 languages in IQ Bot by using
an Распознавание текста (OCR) engine.

IQ Bot architecture diagram
This diagram shows the different components of IQ Bot architecture.
Use the IQ Bot, components, Designer and Валидатор for designing and validating боты, respectively. In
a typical scenario, IQ Bot portal and IQ Bot platform communicate through a network firewall and a load
balancer.

Various protocols are used to communicate between the different components. A database server, a file
storage server, and servers for IQ Bot are used. An organization has the flexibility of using a separate
server for the database or using the Control Room clusterdatabase. A firewall is between the external
components, web browser and Bot Runner, and the data center load balancer. Chrome is the supported
browser.

Using Automation 360 IQ Bot On-Premises
Create a learning instance, train the боты to extract data from documents, and push the learning instance
to the production environment.
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Complete the steps to install IQ Bot.
You must be assigned either the IQ Bot Admin or IQ Bot services roles.
As you configure a learning instance, a Бот builder creates RPA боты to support the learning instance
functions. For more information, see IQ Bot process overview.
1. In Automation 360 IQ Bot, click the LEARNING INSTANCES tab to create a new learning instance,

upload sample documents to train, and select the Распознавание текста (OCR) engine for document
processing.
Создать экземпляр для обучения on page 2504
Select an Распознавание текста (OCR) engine on page 2507

2. Train the uploaded sample documents in the IQ Bot Designer.
Train a learning instance on page 2515

3. As you finish training each бот, set it to Production mode. When all the боты are in Production mode,
set the learning instance to Production mode so it can start processing real documents.
Tasks performed from Bot page on page 2518
Set learning instance to Production on page 2542

Using Automation 360 IQ Bot Cloud
Create a learning instance, train the боты to extract data from documents, and push the learning instance
to the production environment.
Complete the steps to install IQ Bot.
You must be assigned either the IQ Bot Admin or IQ Bot services roles.
As you configure a learning instance, a Бот builder creates RPA боты to support the learning instance
functions. For more information, see IQ Bot process overview.
1. In Automation 360 IQ Bot, click the Learning Instance tab to create a new learning instance and

upload sample documents to train.
Создать экземпляр для обучения on page 2504

Note:  As Tegaki API Распознавание текста (OCR) requires a separate On-Premises set up that is not
supported in Automation 360 IQ Bot Cloud, all other Распознавание текста (OCR) engines except the
Tegaki API Распознавание текста (OCR) are available.
• You will always have the latest version of the Распознавание текста (OCR) engines supported by

Automation 360 IQ Bot Cloud, but cannot select a specific Распознавание текста (OCR) version.
• You cannot configure Распознавание текста (OCR) settings from the Control Room. Starting with

Automation 360 IQ Bot.19 version, we have provided an internal API that can be used to configure
Распознавание текста (OCR) settings in the database.

2. Train the uploaded sample documents in the IQ Bot Designer.
Train a learning instance on page 2515

3. As you finish training each бот, set it to Production mode. When all the боты are in Production mode,
set the learning instance to Production mode so it can start processing real documents.
Tasks performed from Bot page on page 2518
Set learning instance to Production on page 2542
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IQ Bot user personas and roles
Learn about the users that contribute to IQ Bot and the associated roles and licenses. IQ Bot users and
roles are defined in the Control Room.

IQ Bot user personas

A persona refers to the type of tasks that a user performs and the product areas with which a user
interacts. To learn more about how each user contributes to IQ Bot, see IQ Bot process overview.

Тип
пользователя

Описание Roles,
permissions, and
licenses

Access to product
areas

Related links

Bot builder Builds RPA боты
to support IQ Bot
functions such
as training the
Classifier and
pre-processing
documents

Bot developer
role + Bot creator
license

Automation 360 Build RPA боты
for IQ Bot on page
2491

Data engineer Creates learning
instances, trains
боты, and
sends боты to
production

IQ Bot Admin or
IQ Bot services
roles

Following tabs in
Automation 360
IQ Bot
• Dashboard
• Learning

Instances
• Bots
• Domains
• Administration

(IQ Bot
Admin only)

Using Automation
360 IQ Bot On-
Premises on page
2491
Using Automation
360 IQ Bot Cloud
on page 2492

Администратор Uploads custom
domains and
migrates learning
instances
between IQ Bot
environments

IQ Bot Admin role
or a custom role
with the migration
utility permission

Following tabs in
Automation 360
IQ Bot
• Dashboard
• Learning

Instances
• Bots
• Domains
• Administration

Custom domains
in IQ Bot on page
2551
Migrate learning
instances on page
1362

Pseudo-user Runs the RPA
боты to upload,
pre-process,
classify, and
extract data from
documents in IQ
Bot

Unattended
Bot Runner
license + view
learning instance
permission

Automation 360 и
IQ Bot
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Тип
пользователя

Описание Roles,
permissions, and
licenses

Access to product
areas

Related links

Валидатор Manually
corrects fields in
documents that
IQ Bot could not
process

Validator role Only the learning
instances to which
permission is
granted

Use the IQ Bot
Валидатор on
page 2545

IQ Bot функций

A role determines the areas in IQ Bot to which you have access. Roles are assigned in the Control Room
and are of two types, predefined system roles and custom roles. If your user type is Admin, you can create
custom roles.
• System roles: These roles are built in and have a predefined set of permissions that cannot be

customized.
• Custom roles: Эти функции могут быть настроены и изменены, чтобы подробным образом

предоставить разрешения пользователю IQ Bot. An admin can configure the scope of a role with
organization-wide permissions to manage all organizational resources or more narrowly to be limited to
department-level resources. Подробнее см. в разделе Определение пользовательской функции для
IQ Bot on page 2495.

The following table describes the permissions and access areas applicable to each system role:

System role Разрешения IQ Bot Access to tabs

AAE_Администратор IQ Bot Access to all IQ Bot
features and can migrate
learning instances between
environments

• Dashboard
• Learning Instances
• Bots
• Domains
• Administration Migration

utility

AAE_Службы IQ Bot All permissions related to
learning instances

• Dashboard
• Learning instances
• Bots

AAE_Валидатор IQ Bot Can launch the Валидатор for
granted learning instances

Обучаемые экземпляры

Related concepts
Определение пользовательской функции для IQ Bot on page 2495
Для различных функций в рамках IQ Bot можно использовать ролевое управление доступом (РУД),
чтобы разрешить или ограничить доступ пользователей к обучаемым экземплярам, связанным с
ними функциям и функциональным возможностям. Для этого необходимо подробным образом задать
разрешения. Вы также можете использовать РУД для определения пользовательских функций в IQ
Bot.
Related tasks
Creating a user with an IQ Bot specific role on page 2496
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Create users in the Control Room to access IQ Bot.
Related reference
Лицензии Automation 360 on page 1017
На странице Все лицензии отображается подробная информация о текущих лицензиях продукта и
устройства.

Определение пользовательской функции для IQ Bot
Для различных функций в рамках IQ Bot можно использовать ролевое управление доступом (РУД),
чтобы разрешить или ограничить доступ пользователей к обучаемым экземплярам, связанным с
ними функциям и функциональным возможностям. Для этого необходимо подробным образом задать
разрешения. Вы также можете использовать РУД для определения пользовательских функций в IQ
Bot.
IQ Bot поддерживает два типа определений функций:
• Системные функции в Control Room. These roles are built-in and have a pre-defined set of

permissions that cannot be customized. Подробнее: IQ Bot функций on page 2494.
• Пользовательские функции в Control Room. Эти функции могут быть настроены и изменены,

чтобы подробным образом предоставить разрешения пользователю IQ Bot. If you are an admin, by
creating a custom role, you can grant users access to specific learning instances.

If you are a user with the View and Manage Roles permission, you can use the Control Room to create
and assign custom roles.

Разрешение Описание

Просмотреть обучаемые экземпляры Позволяет пользователю получить доступ к
собственным обучаемым экземплярам.

Просмотреть обучаемые экземпляры из одной
функции

Позволяет пользователю просматривать
только обучаемые экземпляры, созданные той
же функцией.

Note:  Если нескольким пользователям
назначена одна и та же функция, то у всех
этих пользователей будет доступ к одним и
тем же обучаемым экземплярам.

Просмотреть все обучаемые экземпляры Позволяет пользователям просматривать все
обучаемые экземпляры, созданные любым
пользователем с любыми функциями.

Редактировать обучаемый экземпляр Позволяет пользователям редактировать
обучаемые экземпляры.

Удалить обучаемый экземпляр Позволяет пользователям удалять обучаемые
экземпляры.

Отправить обучаемый экземпляр в
производство

Позволяет пользователям перемещать
обучаемые экземпляры из промежуточной
среды в производство.

Импортировать домен Позволяет пользователям импортировать
домены в IQ Bot.

Обратите внимание:
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• Проверьте, что у пользователей с разрешением Просмотреть обучаемые экземпляры из
одной функции нет функций, не относящихся к IQ Bot. Пример. When you create a learning
instance, all the roles that you have under your name gets assgined to the learning instance. So, if you
have AA_Basic role in combination with View learning instance from the same role, then all the
users with AA_Basic role have access to IQ Bot. Therefore, users who create learning instances must
not be assigned non-IQ Bot roles.

• Требуется, чтобы создателям обучаемых экземпляров для определенного отдела были назначены
как минимум две функции:
• Функция, позволяющая им создавать обучаемые экземпляры
• Функция для конкретного отдела с разрешением Просмотреть обучаемые экземпляры из

одной функции

• При переносе новых обучаемых экземпляров существующие функции не переносятся. Функции
нельзя изменить после их назначения в целевой системе. IQ Bot A360 не поддерживает
изменение назначений функций обучаемых экземпляров.

Related tasks
Create a role on page 2708
As an administrator, you can configure roles with permissions to access features and perform operations
such as create, edit, or delete a бот in the Control Room, and assign the role to a user.
Creating a user with an IQ Bot specific role on page 2496
Create users in the Control Room to access IQ Bot.

Creating a user with an IQ Bot specific role
Create users in the Control Room to access IQ Bot.
Create administrator, services, and Валидатор IQ Bot users with Microsoft Windows credentials using the
following roles in the Control Room:
• AAE_Администратор IQ Bot
• AAE_Службы IQ Bot
• AAE_Валидатор IQ Bot

Tip:  The Active Directory users are authenticated with their Active Directory credentials, and the
non-Active Directory users are authenticated with the credentials stored in the Control Room database.

Users in Control Room are created depending on the type of user configured during installation.

Note:  IQ Bot supports 50 concurrent users. However, Document Extraction if all users are active at the
same time, then you cannot run Document Extraction in parallel. Additionally, if the number of concurrent
users exceeds 50, system performance might degrade.

1. Log in to Control Room as a user with the AAE_Администрирование role.
2. Go to Administrator > Users.
3. Click the Create User icon.

The Create User page appears.
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4. Enter the required information on the Create User page.

Note:
• The First name, Last name, and Description fields are optional. For a first name and last

name, use numbers, spaces ( ), period (.), hyphen (-), and underscore (_).
• For a Non-Active Directory user, provide information in each field.

5. To create a user with the administrator role, select AAE_IQBotAdmin. To create a user
with the services role, select AAE_IQBotServices, To create a Валидатор role, select the
AAE_IQBotValidator role.

6. Select a license to be allocated to the user from the Allocate a device license to user section.
If no license slots are available for a role, an alert message appears.

7. Click Save to create the user.

To switch a user type from Development to Run-time or vice versa, depending on the automation
requirements of your organization, update the license type from the License Management section in
Control Room.
After a Валидатор or a services user is created, an email is sent to the user. The user is asked to do the
following:
• Verify the email ID and set the Control Room access password, if the Control Room is configured for the

Non-Active Directory users.
• Verify the email ID, if the Control Room is configured for the Active Directory users.

Related concepts
Определение пользовательской функции для IQ Bot on page 2495
Для различных функций в рамках IQ Bot можно использовать ролевое управление доступом (РУД),
чтобы разрешить или ограничить доступ пользователей к обучаемым экземплярам, связанным с
ними функциям и функциональным возможностям. Для этого необходимо подробным образом задать
разрешения. Вы также можете использовать РУД для определения пользовательских функций в IQ
Bot.

Languages supported in Automation 360 IQ Bot
Up to 31 languages are supported in IQ Bot. You can also access up to 190 languages in IQ Bot by using
an Распознавание текста (OCR) engine.
When you review the list of languages in IQ Bot, you will observe the following:
• Some languages are listed multiple times as variants, for example, Norwegian, Norwegian (Bokmal),

Norwegian (Nynorsk).
• Among languages that are written from right to left, only Arabic is currently supported on IQ Bot.
• For languages not in the IQ Bot UI by default:

• These rely on ABBYY FineReader Engine 12.2 for text segmentation and OCR, then IQ Bot for
classification, extraction, and auto-correction.

• Contact your Cognitive Services or Sales Engineering representative to create IQ Bot custom
domains to access these languages.

• In the SQL database and .json file, IQ Bot requires language codes for 160 of the additional
languages to appear in the UI, and culture codes to allow numeric and date validation.

© 2023 Automation Anywhere. All rights reserved.     2497



    Automation Anywhere - Оцифровка

Прим.:
• For ABBYY FineReader Engine and Microsoft Azure Computer Vision OCR engine, IQ Bot uses its text

segmentation + Распознавание текста (OCR).
• For Microsoft Azure Computer Vision OCR engine, user can select any language from IQ Bot's drop-

down, but the API aims to auto-detect the language during processing, and override user selection.

The following table provides a list of supported languages in IQ Bot for various document types:

Язык Document types such as invoice, contracts, health
insurance, purchase order, and so on

Document type - Other

Английский X X

Немецкий X X

Французский X X

Испанский X X

Итальянский X X

Afrikaans X

Арабский X

Bulgarian X

Catalan X

Китайский (упрощенное письмо) X

Китайский (традиционное письмо) X

Чехия X

Датский X

Dutch X

Flemish X

Greek X

Венгерский X

Indonesian X

Японский X

Корейский X

Latin X

Malay X

Norwegian X

Польский X

Португальский X

Romanian X

Russian X

Serbian (Latin) X
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Язык Document types such as invoice, contracts, health
insurance, purchase order, and so on

Document type - Other

Slovak X

Шведский X

Турецкий X

The following table lists the languages that are supported in IQ Bot through a custom domain:

Abkhaz Galician Mari Sioux (Dakota)

Adyghe Ganda Maya Slovenian

Agul Немецкий Miao Somali

Albanian German (new spelling) Minangkabau Sorbian

Armenian (Eastern) German (Luxembourg) Russian and English Sotho

Armenian (Grabar) Guarani Mohawk Sunda

Armenian (Western) Hani Mongol Swahili

Avar Hausa Mordvin Swazi

Aymara Hawaiian Nahuatl Tabassaran

Bashkir Icelandic Nenets Tagalog

Basque Ido Nivkh Tahitian

Belarussian Interlingua Nogay Tajik

Bemba Irish NorwegianNynorsk and
NorwegianBokmal

Tatar

Blackfoot Kabardian Norwegian (Bokmal) Thai

Breton Kalmyk Norwegian (Nynorsk) Jingpo

Bugotu Karachay-Balkar Nyanja Tongan

Burmese Karakalpak Occidental Tswana

Buryat Kasub Ojibway Tun

Chamorro Kawa Old English Turkmen

Chechen Kazakh Old French Turkmen (Latin)

Chukcha Khakas Old German Tuvan

Chuvash Khanty Old Italian Udmurt

Corsican Kikuyu Old Slavonic Uighur (Cyrillic)

Crimean Tatar Kirghiz Old Spanish Uighur (Latin)

Croatian Kongo Ossetian Ukrainian

Crow Korean (Hangul) Papiamento Uzbek (Cyrillic)

Dargwa Koryak Tok Pisin Uzbek (Latin)
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Dungan Kpelle Португальский
(Бразилия)

Vietnamese

Нидерландский
(Нидерланды)

Kumyk Portuguese (Portugal) Cebuano

Eskimo (Cyrillic) Lak Provencal Welsh

Eskimo (Latin) Sami (Lappish) Quechua Wolof

Esperanto Latvian Rhaeto-Romanic Xhosa

Estonian Latvian (language
written in Gothic script)

Romanian (Moldavia) Yakut

Even Lezgin Romany Yiddish

Evenki Lithuanian Ruanda Zapotec

Faeroese Luba Rundi Zulu

Fijian Macedonian Russian (old spelling)

Finnish Malagasy Russian (with accents
marking stress position)

Frisian Malinke Samoan

Friulian Maltese Selkup

Scottish Gaelic Mansi Serbian (Cyrillic)

Gagauz Maori Shona

The following table provides you with links to supported languages for all IQ Bot supported Распознавание
текста (OCR) engines:

IQ Bot supported Распознавание текста (OCR)
engines

List of supported languages

ABBYY FineReader Engine ABBYY FineReader Engine OCR supported
languages

Microsoft Azure Computer Vision OCR engine https://docs.microsoft.com/en-us/azure/cognitive-
services/computer-vision/language-support

Google Vision API https://cloud.google.com/vision/docs/languages

Tesseract4 OCR 4.0.0 https://tesseract-ocr.github.io/tessdoc/Data-Files-in-
different-versions.html

Tegaki API • Японский
• Корейский
• Japanese - English
• Korean - English

Прим.:  The supported languages in IQ Bot must be considered in concurrence with the Распознавание
текста (OCR) supported languages.
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Совет:  If you are unable to see all languages in the IQ Bot UI or if IQ Bot is unable to extract data from
multiple languages in a document, troubleshoot the issue:
Unable to extract data from Multiple languages in a document (A-People login required)

Прим.:  If you are adding custom language to a custom domain, then you must retain the language ID
across all installations from where IQ Bot learning instances will be exported and imported.

О классификаторе
Узнайте о том, как классифицируются документы, и о факторах, влияющих на классификацию.
Когда документы загружаются в обучаемый экземпляр, классификатор сортирует их по группам
документов на основе макета, то есть порядка появления полей на странице. Если документ
загружен в обучаемый экземпляр в производстве и документ не соответствует макету ни одной из
групп документов, классификатор создает новую группу для такого документа.
На приведенном ниже графике показано, как загруженные счета-фактуры, содержащие
определенные поля, сортируются в одну из трех групп, в зависимости от порядка появления полей в
счете-фактуре.
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Кроме того, можно вручную определить группу документов для обработки всех документов с
идентичным макетом. В этом случае IQ Bot обходит классификатор и отправляет документ в
созданную вами группу, которая имеет тот же макет, что и загруженный документ. Эта возможность
полезна, когда OCR не удается обнаружить одно или несколько полей в документе, что заставляет
классификатор без необходимости создавать новую группу документов или отправлять документ в
неправильную группу. См. раздел Create a new document group on page 2504.

Note:  Созданные пользователем группы документов не могут быть удалены.

The Classifier is supported by RPA боты and the IQ Bot Classifier пакет. It contains actions that automate
identifying and sorting the different document types. См. раздел IQ Bot Classifier пакет on page 1654.

Ресурсы

Watch the following videos to learn more about how the Classifier works and how to use it:
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Обучаемые экземпляры, созданные с помощью готовых или
пользовательских доменов

IQ Bot проверяет наличие минимального количества полей, выбранных для успешной
классификации документа. Во всех остальных случаях документ помечается как
неклассифицированный.
Пример.
• Если создать новый обучаемый экземпляр с выбранными полями, от одного до четырех, IQ Bot

проверяет наличие не менее четырех полей из общего числа полей, представленных для данного
обучаемого экземпляра. Аналогично, если создать обучаемый экземпляр с пятью выбранными
полями, IQ Bot проверяется наличие как минимум пяти полей.

• Если создать обучаемый экземпляр с шестью или более полями, выбранными в обучаемом
экземпляре, IQ Bot проверяется наличие не менее шести полей. Например, если в домене
счета-фактуры выбраны восемь полей, IQ Bot проверяет наличие, как минимум, шести полей из
общего числа доступных полей.

Обучаемые экземпляры, созданные с помощью других доменов

Если создать обучаемый экземпляр с несколькими полями, IQ Bot проверяет наличие хотя бы одного
поля и классифицирует документ. Если IQ Bot не находит ни одного поля, документ помечается как
неклассифицированный.

Факторы, влияющие на классификацию

Фактор Примечания

Макет страницы Если макет страницы отличается от исходного документа
в отношении положения содержимого документа, IQ Bot
отправляет документ в другую группу.

Ориентация метки Все метки в документе должны быть ориентированы в
одном направлении. Если присутствуют и вертикальные,
и горизонтальные метки, документ отправляется в другую
группу.

Позиция метки Метки можно расположить в любом месте страницы.
Однако последовательность меток слева направо и сверху
вниз должна быть такой же, как в обучающих документах.

Процент соответствия IQ Bot использует 70-процентное соответствие для меток.

Поля, добавленные после
создания обучаемого экземпляра

Поля, добавленные после создания обучаемого
экземпляра, исключаются из процесса классификации.

Related tasks
Limit the creation of document groups on page 2511
Limit the number of new document groups that the Classifier can create when a learning instance is in
production.

© 2023 Automation Anywhere. All rights reserved.     2503



    Automation Anywhere - Оцифровка

Create a new document group
Manually define a user-created document group to process documents with an identical layout. For
example, invoices from a specific supplier.
• If you have not done so already, Создать экземпляр для обучения on page 2504. After you create a

learning instance, you are redirected to the document groups page, where you create a new document
group.

• Identify the group label. This is the name of the folder in the documents\classify\train directory
where documents with an identical layout are sent. You will provide the group label in the steps below.

• Identify sample documents (maximum 150) that have an identical layout. You can upload more
documents to train the group after the group is created.

1. Navigate to the learning instance details page and click Create group.
2. In the Group label field, provide the folder name that contains the sorted documents in the

documents\classify\train directory.
3. Click Browse to upload sample documents to define the layout.
4. Щелкните Сохранить.

1. Configure the mechanism to sort incoming documents to the correct group:
• To use the Classifier, run the бот with the Train Classifier action to create the classification model

and sub-folders to hold the sorted documents in the documents\classify\train directory. См.
раздел Using Train Classifier action on page 1658.

• Alternatively, create RPA боты identify and sort incoming documents using conditional statements,
such as string-matching the file name or sender. See the String condition in the Цикл пакет on
page 1695 or Если пакет on page 1639.

2. Update the following actions:
• Необязательно. Update the Classify Document action to use Express mode. See step 6 in

Using the Classify document action on page 1657.
• Update the Upload document action to provide the group label. See step 4 in Upload document

action on page 1678.

3. Upload more documents to train the group. When you are done with training, set the group to
production.

4. After you set the group to production: If you have a бот with the Process Documents
action, you must update the action with the group label. See step 7 in Использование action IQ Bot
Обработка документов on page 1675.

Note:  During the production process, you must not move the learning instances or bots from Staging
to Production or vice-versa.

Создать экземпляр для обучения
Create a learning instance and upload sample documents for training. In this step, you define the data
elements for a single document type, such as an invoice or a purchase order, and the fields which you
want to extract.
Ensure the sample documents meet the following requirements:
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• Each document is a separate file. For example, if you have downloaded an email and its attachments
into a single PDF, you must separate the email body from the attachments. См. раздел Using the Split
document action on page 1754.

• The documents are in one of the following supported file types:
• PDF
• JPG
• JPEG
• PNG
• TIFF

• Use documents with a resolution value of at least 300 dots per inch (dpi).
• In staging, you can upload a maximum of 150 documents of 10 MB file size per learning instance.
• In production, you can upload a maximum of 50 MB file size per document. However, the maximum

number of documents allowed per learning instance depends on the license.
• There are no limitations on the number of pages per document in a pdfbox OCR.
• You can upload 60 pages per document in an image-based OCR.
• You can upload up to a file size of 12 MB. You can upload additional documents after creating the

learning instance.
• The file names of the documents that you upload should not start with special characters, such as the

hyphen (-).

Note:
• With the Tesseract4 OCR, currently there is a known limitation which restricts the number of pages per

document to less than 60 pages.
• Azure confidential computing enables organizations to upload encrypted data to secured storage, such

as private folders on a virtual machine. If you upload documents from such secured folders to IQ Bot,
these are moved to Unclassified status as data extraction is not supported for such documents.

When you start with a collection of documents to insert into a digital process, you will probably have a
mix of documents types, formats, and orientations. An invoice, for example, has a consistent set of data
elements, whereas a purchase order contains a different set of data elements. You must create a different
learning instance for each of these document types, using the following steps:
1. Navigate to LEARNING INSTANCES and click the New instance option.
2. In the Create new learning instance screen, enter the following information:

a) Имя экземпляра. Enter a unique name.
IQ Bot version A360.21 and below does not allow duplicate learning instance names. Even if
you delete a learning instance, the name cannot be reused. From IQ Bot version A360.22, it
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is possible to create duplicate learning instance names, as well as reuse the name of a deleted
learning instance.

b) Optional: Описание: Введите описание.
c) Document type: Select the document type from the drop-down list.

Do not choose standard forms as Document type while creating learning instance. Based on
the option you select, a predefined set of form and table fields for the domain type appears. For
example, when you select Invoices, the common forms and tables of an invoice appear.

Note:  If you want to create a domain to use specifically for this learning instance, select
Document type > Other and enter a domain name. In the upcoming steps, you will customize
the domain.
For more information on creating a custom domain, watch the following video:
If you want to create a domain to use in more than one learning instance and you have the
required access permissions, you can work with Automation Anywhere support to create a custom
domain. See Custom domains in IQ Bot on page 2551 for more information.

d) Primary language of documents: Use the drop-down menu to select a language for the
learning instance.
Languages supported in Automation 360 IQ Bot on page 2497
To create custom domains in other languages and access up to 190 languages that IQ Bot
supports, contact Automation Anywhere support.

Important:  If you are unable to see all languages in the IQ Bot interface, troubleshoot the
issue: Unable to extract data from Multiple languages in a document (A-People login required)

e) Upload your documents: Click the Browse option to upload sample documents.

3. Select or de-select fields in the Common form fields and Common table/repeated sections
fields sections.
Form fields appear one time in a document, such as the invoice date or number. Table fields are fields
that reoccur throughout the document, such as the item total or quantity.
To see all the possible fields, click Additional form fields or Additional table/repeated section
fields.

4. Optional: Add additional fields by entering the field name in the Additional form fields or
Additional table/repeated section fields section.
Follow the naming conventions when you enter a name in the Add fields (Optional) field:
• Field names can only begin with alphabetical characters (A-Z and a-z).
• Field names can only include alphanumeric characters and spaces.
• Field name cannot end with a space.

5. Optical Character Recognition: Select the required Распознавание текста (OCR) engine.
Select an Распознавание текста (OCR) engine on page 2507

6. Optional: De-select the My PDF documents do not have images check box. To learn more, see
Disable PDFBox option on page 2514
When this check box is selected, IQ Bot uses PDFBox OCR to process PDF documents; non-PDF
documents are processed by the OCR you selected in the previous step.

7. Checkbox auto-detection: Select the Detect checkboxes check box to enable this feature.
Selecting this option allows IQ Bot to automatically detect check boxes in a document. However, it
might increase the processing time of documents.
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8. Click the Create instance and analyze option to create the learning instance.
The system analyzes and sorts the training documents into logical groups based on field identification
and shows the details in the Learning Instance > Summary tab.

When a new learning instance is created, the sample documents you uploaded are analyzed and sorted
into groups based on the document characteristics. Подробнее: О классификаторе on page 2501.
After the Classifier finishes sorting the documents, you are redirected to the Designer, where you will train
bots to extract data from each sample document. Train a learning instance on page 2515.
Related tasks
Select an Распознавание текста (OCR) engine on page 2507
You can select an Распознавание текста (OCR) engines that suits your requirement for data extraction
based on your document types. Restarting IQ Bot services is not necessary for implementing an engine
change.
Related reference
Create a learning instance for standard forms on page 2564
Learning instance is used in IQ Bot to extract, train, validate content from standard forms. Use the
following instructions to create a learning instance for processing standard forms in IQ Bot

Select an Распознавание текста (OCR) engine
You can select an Распознавание текста (OCR) engines that suits your requirement for data extraction
based on your document types. Restarting IQ Bot services is not necessary for implementing an engine
change.
Во время установки IQ Bot система в качестве модуля Распознавание текста (OCR) по умолчанию
устанавливает последнюю версию Tesseract Optical Character Reader. This is also the default
setting for the product. However, you can manually set the Распознавание текста (OCR) engine in the
Settings.txt file, which becomes the default engine. Similar to the prior releases of IQ Bot, you can
continue to manually update the Settings.txt file with the Распознавание текста (OCR) engine name
you want to set as default.
When creating a learning instance, you can select an Распознавание текста (OCR) engine from the
Optical Character Recognition drop-down menu. См. Создать экземпляр для обучения on page 2504

Note:  Selecting an Распознавание текста (OCR) engine in the interface overrides the settings in the
Settings.txt file.

The following table lists the various Распознавание текста (OCR) engines supported in IQ Bot and the
corresponding options:

Table 4: List of OCR engines and their specifications

Qualifiers Версия OCR Supported
installation

Handwritten Languages
Supported

Document
Quality

Тип
документа

Tesseract
OCR

4 Cloud и On-
Premises

НеприменимоАнглийский
Немецкий
Испанский
Итальянский
Французский

No noise
No dark
background
No stamps/
watermarks
200+ dpi

Invoices,
POs, etc.
Semi-
structured
formats
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Qualifiers Версия OCR Supported
installation

Handwritten Languages
Supported

Document
Quality

Тип
документа

ABBYY
FineReader
Engine

12.3, or 12.4 Cloud и On-
Premises

НеприменимоАнглийский
All Latin+
Chinese
Японский
Корейский

Less noise
Dark
background
with white
fonts
Has stamps/
watermarks
96+ dpi

Invoices,
POs, etc.
Semi-
structured
formats
Mortgage
Forms, Tax
Forms
Unstructured
Formats

Microsoft
Azure
Computer
Vision OCR
engine

2.0 or 3.2 Cloud и On-
Premises

English only Английский
All Latin+
Chinese
Японский
Корейский

Less noise
Dark
background
Has stamps/
watermarks
96+ dpi

Invoices,
POs, etc.
Semi-
structured
formats
Passports,
Driving
license, etc.
Документы
KYC

Google
Vision API

Version is
updated
automatically
to match
current
release

Cloud и On-
Premises

НеприменимоАнглийский
All Latin+
Asian

Less noise
Dark
background
Has stamps/
watermarks
96+ dpi

Invoices,
POs, etc.
Semi-
structured
formats
Mortgage
Forms, Tax
Forms
Unstructured
Formats

Tegaki API Check with
your Cogent
Labs sales
representative

On-Premises
only

Japanese
and Korean

Japanese
and Korean

No noise
No dark
background
No stamps/
watermarks
200+ dpi

Invoices,
POs, etc.
Semi-
structured
formats

1. On the Create a new learning instance page, select the domain and language of the documents.
In the My learning instance list page, a new OCR Engine column is available that shows the
Распознавание текста (OCR) engine used for creating each learning instance. This information is
useful to the user when deciding on document processing.
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2. The Fields to extract and Advanced Settings sections are displayed when you select the domain.
Each domain is available with a predefined list of primary supported languages. Language selection
is enabled and available from the Primary language of documents drop-down list based on
supported languages for a specific domain.

Note:  If you select a language from the Primary language of documents drop-down list and then
select an engine that does not support that language, the system displays an error message in the
Optical character recognition drop-down list.

3. Click Advanced Settings > Optical character recognition to display the Распознавание текста
(OCR) engine options drop-down list.
If the Распознавание текста (OCR) engine selection is invalid, the Create instance and analyze
option is not enabled.

Note:  IQ Bot automatically installs all Распознавание текста (OCR) engines during the installation
process, except for ABBYY FineReader Engine.

Important:  You can only configure the selected Распознавание текста (OCR) engine in Automation
360 IQ Bot On-Premises. Распознавание текста (OCR) settings in Automation 360 IQ Bot Cloud
cannot be edited as they are not accessible except for ABBYY FineReader Engine. You can edit the
configuration settings for ABBYY FineReader Engine using the appConfigurations REST API.

You can select from the following:

Вариант Описание

Tesseract OCR 4 This is the default engine, unless changed in the Settings.txt
file.

ABBYY FineReader Engine To verify if ABBYY FineReader Engine is installed and available
for use on your machine, check the Settings.txt file, the
Распознавание текста (OCR) Plug-ins folder for the SDK files, and
the Optical character recognition drop-down list.

Note:  Also supported in IQ Bot [Local Device] пакет and IQ Bot
Extraction пакет.

Use ABBYY FineReader Engine Распознавание текста (OCR) engine in
IQ Bot on page 1108

Microsoft Azure Computer
Vision OCR engine

IQ Bot supports all languages supported by this Распознавание
текста (OCR) engine.
Use Microsoft Azure Computer Vision OCR engine on page 1105

Google Vision API IQ Bot supports Google Vision API as an Распознавание текста
(OCR) engine and supports all languages supported by this engine.
Use Google Vision API OCR engine on page 1111
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Вариант Описание

Tegaki API IQ Bot supports his Распознавание текста (OCR) engine to extract
data specific to Japanese and Korean language documents. You
need to download and use your private license to use Tegaki API.

Note:  Tegaki API Распознавание текста (OCR) engine is not
supported in Automation 360 IQ Bot Cloud.

Использование модуля Распознавание текста (OCR) Tegaki API on
page 1114

В моих документах PDF
отсутствуют изображения

All the PDF documents that you upload are processed using the
PDFBox Распознавание текста (OCR) by default, regardless of
the Распознавание текста (OCR) engine you have specified or
selected.
If you are uploading non-PDF documents or PDF documents that
contain images, clear the My PDF documents do not have
images check box to ensure that the Распознавание текста (OCR)
engine that you have specified or selected is used to process the
documents.
The My PDF documents do not have images check box is
enabled by default. To disable this feature, see Disable PDFBox
option on page 2514.

Tip:  If IQ Bot is unable to extract data from low quality or handwritten documents, troubleshoot the
issue:
IQ Bot unable to extract data from low quality and Handwritten documents (A-People login required)

Note:  Use the following files to change the Распознавание текста (OCR) settings:
• AbbyyImagePreProcessingSettings.json
• LangugeCodeToAbbyyLanguageCode.json
• TegakiOCREngineSettings.json
• Azure3OCREngineSettings.json
• GoogleOCREngineSettings.json
• AzureOCREngineSettings.json

How to change OCR Settings in IQ Bot (A-People login required)

Edit a learning instance
Edit a learning instance to change its name, description, add additional training documents, or include
additional fields for extraction.
You can only edit a learning instance on Staging. So ensure you move any learning instance in Production
environment to Staging to edit it.
1. On the Learning Instances page, click a learning instance.
2. Click the Edit icon to edit the learning instance.
3. Optional: Update the description field.
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4. Optional: Change or update the learning instance name.
When you change the name of a learning instance, the following changes occur:
• A separate folder with the new learning instance name is created in the configured output directory

to store the .csv files of processed documents.
The previous folder containing the .csv files before the learning instance name was changed
remains as is in the output folder.

• When you migrate a learning instance with an updated name using overwrite or remove options, it
is updated in the source environment after the .iqba file is imported.

• An entry in the audit logs is created for this activity.

5. Optional: Click Browse to select additional training documents.
The file names of the documents that you upload should not start with special characters, such as the
hyphen (-).

6. Optional: Select additional fields and table columns to add to the learning instance for data extraction.
7. Use the New groups creation setting field to restrict creation of new groups or set the threshold

for the number of groups.

Note:  The New groups creation setting field only applies to the documents in Production.
However, this field option is not applicable for IQ Bot [Local Device] and IQ Bot Extractionпакеты.

Подробнее см. в разделе Limit the creation of document groups on page 2511.
8. Optional: Use the Default validations group option to select a default group for document

validations.
All new documents use the custom logic and validations defined in the default group. Validation
rules from this default group are applied when a document does not belong to any of the existing
group. If you delete the selected default group, the validation rules are not applied to any of the new
documents that were supposed to use this group.

Note:  If you select a default group, you can only change it to another group. However, you cannot
select Select default validation, which is the default setting.

9. Click Save to view a confirmation message.
10. Click Yes, proceed with field addition to upload, analyze, and classify the selected training

documents (if any) that were added to the learning instance.
The classification of documents remain unaffected by the newly added fields.

All additional fields become available in all the боты and appear as optional fields in the selected learning
instance. The боты must be retrained for these fields.
См. раздел Errors generated while editing learning instances on page 2513.

Limit the creation of document groups
Limit the number of new document groups that the Classifier can create when a learning instance is in
production.
You can only edit a learning instance that is in staging. If the learning instance is in production, you must
revert it to staging.
Когда документы загружаются в обучаемый экземпляр, классификатор сортирует их по группам
документов на основе макета, то есть порядка появления полей на странице. Если документ
загружен в обучаемый экземпляр в производстве и документ не соответствует макету ни одной из
групп документов, классификатор создает новую группу для такого документа.
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Use the following steps to either configure a limit for the number of total document groups in the learning
instance, or opt to disallow the Classifier from creating new document groups.
1. Navigate to LEARNING INSTANCES, select a learning instance, and click Edit.
2. Выберите один из указанных ниже параметров.

Вариант Описание

Select the Never create new groups
check box

No new groups are created, irrespective
of the number of document uploads. The
uploaded documents are sent directly to the
Валидатор.
• This check box is deselected by default.
• When this option is selected, the

Threshold to create new groups field
is disabled.

• You can create new groups manually by
uploading them to the learning instance
in staging.

Set a value for the Threshold to create
new groups field

When you set a threshold value, IQ Bot
does not create a group for the uploaded
documents till it reaches the defined value.
Till the set threshold value is reached, all
documents are sent to the Валидатор.
• By default, the value is set to 10 for all

new learning instances.
• You can set a value of up to 10 digits.
• IQ Bot does not allow you to enter non-

numerical characters, zero, or floating
points.

3. Save your updates, which are then reflected in the Summary tab.
The Summary tab displays all the staging and production details. The information is updated based
on any applied setting in the New groups creation setting section.
For new learning instances, unless you set the minimum threshold in the New groups creation
setting section, IQ Bot applies the default set value of 10 and does not create groups for the first 9
uploaded documents.

4. For existing learning instances, you can set the minimum threshold in the Learning Instance > Edit
page. The new threshold is applied to all documents from then onward.
All existing learning instances, even after upgrade, will continue with a threshold as 1.
All changes take effect only on the documents uploaded in production after the setting is edited.
If you change the setting to a new threshold or never create new groups with an existing learning
instance, this check will be performed only on the next document uploaded in production.

In the production environment, all classified documents that do not belong to any group and do not meet
the minimum threshold requirement are sent to the Валидатор. You can update the values and make
necessary corrections. However, all fields are optional and are text data type. The user can Save current
document without making any corrections, or choose the Mark as Invalid option.
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Errors generated while editing learning instances
Use case scenarios and error messages generated while editing a learning instance are explained in this
topic.

Обращение Сведения Сообщение

Бот in training Learning instance is in use
because of ongoing бот training
and you edit the same instance
A) User 2 is editing the same
learning instance

Case 1: Simultaneous editing of
same learning instance

Example for case 1:
User 1 uploads a document to
the same learning instance.
User 2 adds a field when editing
the same learning instance.

Run and edit the same бот Run the бот and then edit
the same бот using the same
user login or two different user
logins.

Delete a learning Instance
Use the Learning Instances page to delete a learning instance from the View Details page.
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You cannot delete a learning instance that is in the production environment. To edit a learning instance, do
the following:
1. On the Learning Instances page, click the learning instance or View Instance Details icon to

show the Summary tab.
2. On the details page, : click the Edit icon. The learning instance becomes available for editing.
3. To delete the learning instance, click the Delete Instance button. A confirmation message appears.
4. Enter the learning instance name in the field and delete the learning instance.

Important:
Unless you have already exported the learning instance as a backup, the following occurs after you delete
a learning instance:
• It is permanently deleted and cannot be restored.
• All the associated боты are deleted and cannot be reused.
• You cannot reuse a deleted name for a learning instance to create a new one.

Disable PDFBox option
The PDFBox option is enabled by default. Disable the option when you are training hybrid PDF documents
containing images and text.
The PDFBox option works best with completely digital documents only. When using hybrid documents
containing images and text, our recommendation is to disable the PDFBox option for better document
classification.

Note:  The PDFBox option is enabled in the system by default. Ensure that the PDFBox is kept enabled
only if you plan to process digital documents, otherwise processing will fail.

If PDFBox is enabled, you can process the following PDF types:
• Vector and Hybrid PDF can be processed using PDFBox
• Raster PDF can be first processed using PDFBox, and if no segment is found then the PDF is processed

again using Document Image OCR

There are two ways in which you can disable/enable the PDFBox option in IQ Bot:
• Directly in the UI during the creation of a learning instance. In the Create new learning instance

page go to Advanced Settings > Optical character recognition and disable/enable the My PDF
documents do not have images check-box.

• In the Setting.txt file described as follows:

1. Navigate to C:\Program Files (x86)\Automation Anywhere IQ Bot\Configurations.
2. Open the Setting.txt file, and change PDFBoxOCREnabled=true to

PDFBoxOCREnabled=false

This turns off the processing of uploaded documents by PDFBox for new learning instances (after
applying this change), and does not apply to the existing learning instances. IQ Bot will use your
selected OCR engine for PDF documents as well.

Note:  When PDFBox is disabled, ensure that your PDF document is less than 60 pages.
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3. After updating the Setting.txt file, execution of stoppedanduninstalled and
installedandstartedstart of IQ Bot services is not required.

Train a learning instance
Use the staging environment to train a learning instance and extract data from sample documents. Review
each field to verify whether the correct value is extracted and where necessary, map the correct field.
When you upload sample documents while creating a learning instance, the Classifier analyzes and
categorizes these documents into logical groups. The system creates a бот for each document group,
which you must train to extract data from specific fields in the sample documents.
The following steps provide an overview of the training process:

Шаг 1. Open the Designer From the My Learning Instances page, open a
learning instance and click Edit bot or Create bot
to start training the learning instance.
For an introduction to the components, see
Introduction to the Designer on page 2517.

Шаг 2. Map the document fields In the Fields section, click each form field to verify
whether the correct value is extracted. If the value
is incorrect or if the field was not found (indicated
by a grayed-out check icon next to the field), you
must remap the field.
• Map a field on page 2520
• Delete mapping in the Designer on page 2527

Шаг 3. Map the check boxes (if applicable) If you configured the learning instance and
uploaded sample documents containing check
boxes or option buttons, see Extract data from check
boxes or check box groups on page 2525

Note:  Check boxes and check box groups can be
extracted as either a form or table field depending
on whether the check box appears one time or on a
recurring basis in the document.

Шаг 4. Map the table fields Review each table field to ensure that the correct
column name is identified in the Column Value
field. If IQ Bot did not find the correct Column
Name, remap the column name by using the same
approach as you did for the form fields. Then,
configure the table settings. Map a table on page
2522
If the document contains more than one table,
define the additional tables:
1. Add all the table fields to the Additional

table/repeated fields section of a learning
instance. Edit a learning instance on page 2510.
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2. Map the additional table fields. Add multiple
tables in Designer on page 2524.
To establish a relationship between the fields
of the different tables, see Define one or more
linked fields in a child table on page 2524.

Шаг 5. Review the training results Click See extraction results to check the
extracted data from the document group. Preview
extracted data on page 2526
If not all of the fields are extracted, try resizing the
mapping areas for those fields.
Alternatively, train the бот by using a different
document. Change the training document for a group
on page 2518

Шаг 6. Save the bot Click Save and go to next group to train the бот
for the next document group.
A menu appears, with the option to Cancel, Save,
or Save and send to Production.

Note:  We recommend that you test the бот (see
next step) before sending it to production.

You can view the status of all the боты in all your
learning instances from the BOTS tab. Manage IQ
bots

Шаг 7. Test бот extraction capabilities Navigate to the BOTS tab and click Test bot.
The бот processes the remaining documents in the
document group based on the trained document. To
see the бот performance, review the values in the
Learning instance summary page, particularly
the straight-though processing (STP) metric. Review
the learning instance details on page 2527
If the STP number is low, you can either retrain the
бот, such as by resizing the mapping areas or train
the бот on a different document. Change the training
document for a group on page 2518

Шаг 8. Send the бот to production When you are satisfied with the extraction accuracy
of the бот, switch it to production mode. Then,
switch the learning instance to production mode.
Once a learning instance is in production mode,
IQ Bot is ready to begin processing documents in
real time: classifying the uploaded documents to
the document groups with боты in production and
either extracting data or sending the document for
manual validation.
From the Learning Instance Details page, click
the switch at the top right to move the learning
instance into production mode. Set learning instance
to Production on page 2542
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Note:  If you want to retrain a бот, both the
learning instance and the бот must be in staging
mode.

Related concepts
О классификаторе on page 2501
Узнайте о том, как классифицируются документы, и о факторах, влияющих на классификацию.

Introduction to the Designer
The Designer is the user interface where you train боты to extract data from uploaded sample documents.
The Designer contains auto-mapped fields and table columns, where you can you edit the existing
mapping or add new fields and tables.

Highlighted areas are:
1. Fields panel: List of fields selected for extraction during Learning Instance creation. Fields

successfully found are indicated with a green check mark.
2. Field Details panel: Details for the highlighted field in the Fields Panel, including data type and

extracted value.
3. Document Image panel: Rendered image of the document with image view controls
4. Form fields: A field that has a single value in the document, such as the invoice number or invoice

date.
5. Table fields: A field with values that appear more than one time in a document, such as the item

description or quantity.
6. The blue boxes indicate System Identified Regions (SIRs) where IQ Bot found extractable data.
7. The training document can be changed by clicking View each Group (#) document.
8. The extraction can be tested using See extraction results.
9. Save and close: Saves the changes and returns to the Learning Instance details page.
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10. Save and go to the next group: Saves changes, allows the Group to be set to Production mode,
and moves to the next available Group.

Note:  If you have multiple files in a group and one of the document is deleted, then you will see an error
message Unable to load document and you will not be able to change the document for training in the
Designer. When the entire multi-page document is deleted or corrupted, you will not be able to navigate
between the pages. If you click the next page button, then the Loading document screen is displayed.

Change the training document for a group
During document training, look at unique document layouts available in a group, and choose a different
document than the default one chosen by IQ Bot Designer, that is more representative of documents
across that group. That helps maximize straight-through processing (STP).
Follow the steps to choose a different document from a document group.
1. User can see the View each Group 'x' document button in the Designer training page next to the

document name.
The View each Group 'x' document button is disabled if there is a single document in the group.

2. Click the View each Group 'x' document button to display the previous and next arrows that will let
you move to another document. You can also cancel out of the task.
Choosing a different document as the group's training document will clear all mapping from the
previous document. IQ Bot displays a warning message stating the same.

3. Select a new document and click the Change the training document button to see a message
confirmation stating: If you change the training document for this group, any
mapping from the previously trained document will be lost. Do you want to
change the training document for <group name> to <document name>?

4. Choosing No, cancel takes you back to the Designer, whereas confirming the message Yes, change
loads and launches the new document with auto-mapped fields.

5. Click See extraction results to view extracted data from the new document.

Tasks performed from Bot page
This page lists all the available боты for a learning instance, and enables you to perform tasks such as run,
change the status, or launch the IQ Bot Designer.
Create a бот to extract text from a document. Define the field labels and values in a document so that the
system can learn from it and automatically process other documents in the document group..
Monitor the progress and status of all боты created for a learning instance and set the status from Staging
to the Production environment.

Testing a бот verifies that the бот can reach the required accuracy based on the training. It also runs it
against all the sample documents associated with that category or group and benchmarks document and
field accuracy. Test a бот only in the Staging environment.

Note:
• To view the updated document and field accuracy, refresh the Bots page and click the бот name. The

updated document and field accuracy appear in the details area.
• You cannot edit a бот that another user is already editing.
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Various бот states

The status of a бот is dependent on the state of the learning instance as well as the bot. The table below
shows the relationship between learning instance state, бот state, and бот status.

Learning Instance State Bot State Bot Status

Staging Staging Обучение

Staging Производство Ready

Производство Staging Обучение

Производство Производство Активный

Создан Not created No listing

Delete a бот

The following are some key points:
• Clicking the Delete bot button displays a message asking if you want to delete the Бот. Selecting

yes displays a success message in the Learning Instance details page. The Summary tab shows the
updated information in the Staging and Production results sections for the Groups found and Bots
created fields.

• You can delete a Бот in Staging only. Once deleted, the Бот does not display in the Learning Instance
details page or the Бот listing page.
• All associated staging documents are removed from the system.
• All associated unprocessed production documents get moved to the Валидатор for processing.

Note:  A new Бот is created when the same documents are uploaded again to Staging or Production.

• On re-uploading the deleted documents from the learning instance, the system classifies the documents
and displays the groups again with the Create Bot option for each group. Clicking the Create Bot
option creates the Бот and you can see it in the Create Bot details page.

• In case of backend exceptions, such as disruption of Services, the system does not let you delete the
Бот. Instead, it displays an error message saying that an unexpected error has occurred.

Related tasks
Создание первого бот on page 1066
Выполните следующие шаги, чтобы создать первый бот, который печатает сообщение (Go be
great!), версия Automation Anywhere Hello World!

Improve output quality using OCR confidence
Improve the output quality of the IQ Bot platform using the system-identified region (SIR) and optical
character recognition (OCR) confidence by comparing it to a predefined threshold.
Confidence-based validation is useful for a text type field and for Date or Number fields because it helps
route a document, with contentious values, for a human to view despite the fields satisfying the set
validation criteria.
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Enable OCR confidence-based validation

Note:  This option is applicable only if you selected Tesseract OCR when creating the learning instance.

Эта функция по умолчанию отключена. To enable this feature, open the Settings.txt configuration
file available in <IQ Bot Installation Folder>\Configurations\, and set the desired threshold
value in the ConfidenceThreshold property. For this example, set the character-level confidence
threshold value to 99, that is ConfidenceThreshold=99. When this feature is disabled, the default
value is set to 0, signifying that the feature is disabled.

Note:  The confidence threshold value is uniformly applicable across all the learning instances.

How OCR confidence-based validation works

In a document if a field's SIR character level confidence is lower than that of the set confidence threshold,
the validation for that field fails, resulting in the failure of that document.

Note:  If a field value fails due to a validation rule (for example, Invalid Number Format) other than an
OCR confidence validation failure, you see that tooltip, and not the tooltip for Low confidence.

While training a document, a confidence-based validation failure against a field appears in an orange box
during preview if no other validation errors exist for that field. Other validation errors take precedence over
OCR character-level confidence validation.

Troubleshoot:  If the OCR engine is not able to identify SIRs for Chinese language PDF documents,
troubleshoot the issue:
• Data objects (SIRs) are not identified by OCR for Chinese PDF documents (A-People login required)
• How to convert PDF files to TIFF files (A-People login required)

Map a field
When you are training a learning instance, if a field value was extracted incorrectly or if the field was not
found, you must remap the field.
If you have not done so already, first create a learning instance with sample documents. Создать
экземпляр для обучения on page 2504
For an introduction to the components, see Introduction to the Designer on page 2517.
The Designer image display panel contains blue boxes that surround text, date, or number type data. Each
of these blue boxes is a system identified region (SIR) that indicates that IQ Bot has identified that region
as containing extractable data. Perform the following steps to map a field to teach IQ Bot to extract data
from that field (for example, the invoice number) from a specific region (for example, the top-right side of
SIR).
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Note:  These steps apply only to text, number, and date data types. IQ Bot also supports check boxes.
Подробнее см. в разделе Extract data from check boxes or check box groups on page 2525.

1. Select a field and specify the data type from the Data type list.

Note:  If a field value contains a mix of letters and numbers, such as invoice number, select the Text
option.

2. In the image display panel, click the field from where you want to extract data.
IQ Bot tries to identify and autopopulate the corresponding field value in the field details panel.

Tip:  Use the pipe symbol (|) to add field aliases, which represents alternative text that might be
present in an SIR. For example, if the recipient's information is in a field labeled Sold to in some of
the documents and in Ship to in other documents, enter Sold to | Ship to as the field label.

3. Optional: Drag the corners of the green-bounded box to resize the mapping area.
Alternatively, draw a new mapping area by holding and dragging the cursor.
When you resize any value region or create your own value region using select, its position is fixed
relative to the field label. The value for that field is always searched in that relative region.
Reset a fixed field region defined by the user in the autodetected mode by clicking the close button at
the top-right corner of the field.
For additional information, see What are the different ways to map form fields in IQ Bot (A-People login
required).

4. Optional: If the column value is not consistently available in the training documents, expand the Field
options section and select Optional.

5. Optional: Add validation patterns or custom logic.
Designer validation patterns on page 2528|Adding custom logic to improve automatic extraction in
production on page 2537

Review each field to verify whether the correct value is extracted. Then, proceed to mapping table fields.
См. раздел Map a table on page 2522.

Use list validation to improve accuracy of a text field
Setting validations while defining any field or table column while mapping the document class helps
validate a field or table column against predefined parameters so that you can be warned if any mismatch
is found during the data digitization process.
Enter each text value in a separate line.
• The бот validates extracted value of field/table column against this predefined list and checks for any

mismatch found during the See Extraction Results phase.
• Besides validating, the process also helps auto correct the extracted values.
• Errors in validation are marked with a red border and can be seen in the See Extraction Results

phase. Move your cursor over the error to know the error type.

If list validation value is Adam, and the extracted value is Adem; the extracted value will be auto
corrected to Adam. In this example, there is a 75% match of characters; and threshold for match is at
least 66%.

Use validation patterns/lists to flag discrepancy in extracted data
Use validation patterns/lists to flag discrepancies in extracted data and prevent incorrect data from going
through.
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When a date/number format pattern is explicitly specified, the date/number is auto corrected.
See the following examples:

Таблица 5. Example of date format pattern

Incorrect OCR Data Шаблон Auto-Correction

15 10-2015 dd-mm-yyyy 15-10-2015

Таблица 6. Example of number format pattern

Incorrect OCR Data Шаблон Auto-Correction

123 4567 9999999 1234567

Map a table
IQ Bot uses column names as reference points when extracting values from tables. As part of training a
learning instance in the Designer, you must map the column names and configure the table settings.
Create a learning instance and map all the form fields in the Designer. Map a field on page 2520

1. Skipping the Table settings section, click the first table column in the Table fields section.
2. Click the name of the column from where you want to extract data in the image display panel.

There are two ways to map the column values:
• Option 1: For a basic table that is contained within one page, map the column name to the

Column value field.
• Option 2: If the table spans multiple pages, we recommend mapping the Column value field to

an entry in that column that has the greatest height and width among the entries in that column.

Depending on which mapping option you choose, IQ Bot autopopulates the Column value field in the
field details panel with either the name of the selected column or the value of the selected table entry.
In addition, the selected SIR in the document is highlighted with yellow color for easy identification.

3. Optional: Drag the corners of the green-bounded box to resize the mapping area.
Alternatively, draw a new mapping area by holding and dragging the cursor.
When you resize any value region or create your own value region using select, its position is fixed
relative to the field label. The value for that field is always searched in that relative region.
Reset a fixed-field region defined by the user in the autodetected mode by clicking the close button at
the top-right corner of the field.

Tip:  For additional information, see How to map tables in IQ Bot (A-People login required)

4. Expand the Field options section and select Required or Optional. Use the optional value if the
column value is not consistently available in the training documents.

5. Optional: Provide validation patterns.
Designer validation patterns on page 2528

Configure the Table settings section. Ensure that you map all the other fields in the document before
populating this section.
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6. Review the selected option in the Best field for table/repeated section field. IQ Bot autodetects
the table field that best defines the height of the rows in the table. You can select a different column
from the list.
Other columns are extracted in reference to this column. For example, if the Best field for table/
repeated section has five rows, then a maximum of five rows will be extracted from the other
columns.

Note:  Ensure that this field does not contain multiple lines or is empty.

7. Optional: Map a field label for the End of table indicator field to specify where to stop extracting
data from that table.
For example, an invoice might contain the subtotal, sales tax, and total in the table, but because each
of these fields has only one value per document, they should not be extracted as part of the table.
Provide the name of the first field that appears where the table ends, for example, Total or Grand
 Total.
Provide the value for the End of table/section indicator field in any of the following ways:
• In the Image display panel, select an SIR to populate that text value as the End of table/section

indicator.
• Alternatively, type a value directly into the End of table indicator/section field, in the middle

panel.

Tip:  Use the pipe symbol (|) to add field aliases, which represent alternative text that might be in an
SIR. For example, Subtotal | Subtotal Amounts refers to Subtotal OR Subtotal Amounts.

For an example of how to map one table for extraction in a document that contains multiple tables,
see Mapping a table in a page with many tables on page 2523.

8. If you mapped a table value for the Column value field (option 2 in step 2): Expand the
Advanced table options section and select Stop extraction at "end of table indicator".

9. Optional: Enter custom logic.
Adding custom logic to improve automatic extraction in production on page 2537

Click See extraction results to check the training results for table data and remap the fields if required.
Preview extracted data on page 2526

Mapping a table in a page with many tables
This example guides you in using the Extract Table Summary Rows and End of table indicator fields
to extract one table in a page that contains many tables.
If you have not already done so, create a learning instance and map all the form fields in the Designer.
Map a field

In this example, a page in a document contains more than one table, but the objective is to extract only
one of the tables. User is in the Designer training a бот, with at least one table having duplicate or similar
regions matching those of another table. Extract Table Summary Rows functionality does not impact
data extraction irrespective of whether user specifies the End of table indicator value.
1. Create two tables with similar or duplicate areas. For example, one table with claims total and other

with record details related to line number.
2. Map all table columns related to line number.
3. Map all value columns without table label, but related to claims total.

Claim totals table has duplicate or similar areas like another table related to line number. So the billed
amount column is a duplicate area for both tables.

© 2023 Automation Anywhere. All rights reserved.     2523



    Automation Anywhere - Оцифровка

4. Map one column of claims total table with the claims total label, as at least one column label is required
for data extraction for a table.

5. Click on See extraction results to see duplicate rows that have duplicate or similar areas on claims
total table. For example, When single page has multiple claim totals records.

6. Click Back to training to return to the training page.
7. Navigate to Claim totals table > table settings, and check the box for Extract Table Summary

Rows label under Advance Table Options.
8. Enter value for End of table indicator and click on See extraction results.
9. User can see rows in claims total table related to claims total only.
10. Click on Export to CSV to open the file.
11. User can see table related to claims total extraction, as seen in preview.
12. Next, set the learning instance, and бот to production and upload some files related to the бот.

• If the бот does not have any validation errors, the user can see claims total table as per mapping in
production CSV file.

• If the бот has some validation errors, the user can see claims total table as per mapping in the
Валидатор.

Add multiple tables in Designer
If the sample documents contain more than one table, you must map the columns and configure the table
settings for each table.
Create a learning instance and map all the fields in the Designer. Map a field on page 2520
Map the columns for the first table. Map a table on page 2522
Add multiple tables in the Designer to extract their value and validate them. Move one or more table fields
from one table to another to train extraction. To add tables do the following:
1. In the Table fields panel, click Add Table.
2. Select the columns to add from the Available columns list and click the arrow to add to the new

table column list.
3. Map the column names and values as you did for the first table, then configure the Table settings

section.

Resources

Click See extraction results to check the training results for table data and re-map the fields if needed.
Preview extracted data on page 2526

Define one or more linked fields in a child table
In the Designer, define one or more linked fields/sections in a child table, to link parent and child tables in
a flexible way.
Use the linked fields in a child table feature in Designer to create table links, and a hierarchy of table links
among parent and child tables. This helps efficient data extraction of the linked fields besides easy linking
among tables. Foreign key data extraction allows the following relationships only:
• Link single parent row to a single child row (one-to-one linking).
• Link single parent row to multiple child rows (one-to-many linking).
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Прим.:  IQ Bot does not support linking of check boxes.

Use the feature for documents with a list of names or IDs with specific information on each. For example,
documents from an electric company with a list of customers and their billing/usage information. Or a
document with a list of student names displaying their test scores. Create multiple tables and link the
common fields thus allowing efficient and accurate data extraction. IQ Bot supports linking of up to 50
columns and unlimited rows. However, data extraction from rows spanning across multiple pages is not
supported.
• Single parent-child table field/section linking:

In the Table/Repeated Section of the Designer, choose one or more fields/sections from a parent
table to link to a child table.
1. Click Table Settings in the child table and click on Link Table Fields and select the parent table

from the drop-down list of table names. This displays the available column options in the parent
table you can choose to link to.

2. Select the columns you want linked and click the downward arrow to link the columns to the child
table.

3. The linked columns display under child table > Table Settings > Linked to (table name).
4. When previewing the extracted data (click See extraction results), the linked fields from the

parent table show up in the extreme left columns of the child table.

• Multiple hierarchical table field/section linking:
When linking table 1, 2, and 3 in a hierarchy, link in a way so that table 1 is the parent of table 2, and
table 2 is parent of table 3. All three tables would be linked. Child table 3 would display linked fields
from table 2 and 1. IQ Bot supports hierarchy linking up to six tables at a time.

Прим.:  For table 3, you can only choose fields from table 2 that are not from table 1.

When previewing the extracted data for child table 3 (click See extraction results), the extreme left
columns show linked fields from table 1. The next columns show linked fields from table 2.

Важное замечание:  For successful linking, the child table must be at the same or lower level than
the parent.

Extract data from check boxes or check box groups
Train a бот to extract data from a single check box or a group of check boxes.
Флажок — это объект пользовательского интерфейса, который позволяет сделать двоичный
выбор: выбрать определенную функцию или оставить ее невыбранной. IQ Bot поддерживает
извлечение данных из флажков или переключателей, отмечаемых галочкой, крестиком или точкой.
В дополнение к квадратным флажкам и круглым переключателям IQ Bot поддерживает треугольные
и ромбовидные контуры.
When IQ Bot processes documents with a check box, it extracts either a Yes (check box selected) or No
(check box not selected) value.
You can also combine multiple check boxes into a single group, for example a payment methods group
that contains check boxes for cash, credit card, and check. When IQ Bot processes documents with a
check box group, it includes the group name in the extraction results.
Recurring check boxes or groups
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By default, IQ Bot extracts check box values as a form field. However, if a check box or group appears
on a recurring basis in the uploaded documents, you manually select the Column option so that IQ Bot
extracts the values as table fields. This enables IQ Bot to extract values from the subsequent occurrences.
Otherwise, IQ Bot will only extract the check box value the first time it appears.
1. Click the field you want to map from the left panel.
2. In the center panel, in the Data type drop-down field, select value as check box or checkbox

group.
• To extract data from single check box or check box groups, click the Field label field and

then click the corresponding value in the document in the right pane.
• Extract data from recurring check box or check box groups, click the Column name field

and then click the corresponding value in the document in the right pane.

3. To extract the check box value, draw an outline around the check box excluding the value.
• For a single check box, use the Draw tool to draw over the check box or select the auto-

mapped check box segment.
• For a check box group, use the Draw tool to draw over the region covering all the check boxes

in that group.

4. For single check boxes or check box groups: Verify the extracted data either in the Field value
field in the Designer or click See Extraction Results to see the extracted data.
For recurring check boxes or check box groups: You can only view the extracted data by clicking
See Extraction Results; the extracted data is not shown in the Designer.

5. Необязательно: To add an individual check box to a check box group, select the desired value from
the Checkbox group drop-down menu.

6. When you are done configuring the check boxes, click Save and close or Save and go to next
group.

Preview extracted data
Click See Extraction Results to review the extraction accuracy of the бот. This is the only way to see
extraction results for table data, since the Designer does not show extracted table data during training.
Alternatively, click Export to CSV to review the data in a CSV file.
The extraction result window displays the following information:
• Successfully mapped fields and the extracted values.
• Table headers and the values for each row.
• Extraction errors, which are highlighted within a red box. Hover on the error to learn more, such as if

there was a validation error or lack of OCR confidence.

Note:  The time required to display the extraction results can vary based on the complexity of the Python
logic that you have created.

Important:  A training document can pass in spite of an error flagged by the validation pattern.
Sometimes we want a validation pattern to flag an error, so it would not pass specific documents at a later
stage in production; instead enter them in the manual validation queue.

Close the window to return to the Designer.
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Important:  If you upload 30 documents and all documents are classified into one group, you can see
only one document for each unique layout.

Export data to a CSV file

You can export the extracted data to a CSV file for ease of review. When you click Export to CSV, the
current document is downloaded to your device. To download other documents you must navigate to them
using the < and > buttons.
The data in the downloaded CSV file is displayed exactly how it will appear when IQ Bot downloads data
from a successfully processed document from a learning instance in production mode.

Review the learning instance details
Review various details of a learning instance such as associated groups, environment status, staging and
productions results, total number of tested documents, modified date and so on.
On the My learning instances page, select a learning instance and use the following tabs to review the
details:
• Document Groups- Contains a list of the document classification groups for the learning instance.

When you create a learning instance and upload documents to train, documents are automatically
categorized in the same document group based on their content and classified accordingly. These are
termed as classification groups. A бот is more likely to succeed extracting text across documents in a
group with similar content.

• Summary- Contains various details about the learning instance such as Staging and Production results,
current environment that the selected learning instance is in, total number of associated groups and
боты, and so on.

Note:  The system does not automatically refresh (auto-refresh) the My learning instances unless the
user loads a screen or clicks the Refresh button, thereby manually refreshing data on a page. This feature
helps reduce the response time for loading new data or performing any action in IQ Bot.

Related concepts
Обзор информационной панели on page 2548
Информационная панель обобщает отчет о работе и предоставляет информацию об обработке
документов в графическом формате.

Delete mapping in the Designer
Delete mapping of field labels and field values, selecting the X delete symbol next to the mapped label or
value.
The following use cases explain the delete field labels and value mapping options in the Designer.

Delete a field label and its mapped value: Select a field label in the middle panel and click the
X delete symbol of the bound box in the document
view to delete both, label and value mapping . The
label and the value from the middle panel gets
deleted as well. The mapping check mark in the
left and middle panels turns from green to gray
indicating incomplete mapping.
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Delete field value: Select the field value and click the X delete symbol
of the mapped box in the document view, to delete
the mapped value. The value from the middle panel
gets deleted as well. The check mark in the left and
middle panels turns from green to gray indicating
incomplete mapping.

Delete auto mapped value fields: The X delete symbol of the mapped box in
document view is not visible till user resizes or
manually maps it.
For a form field, when a user deletes a resized or
manually mapped box around a the field value, IQ
Bot repopulates the original auto mapped value.
For a table/section field, that same behavior does
not apply, as a user has the option to map a table/
section field name but not a field value, and vice
versa.

Delete a field label/value with or without
auto mapped value:

Select a field label/value with or without auto
mapped value. The field label bound box displays
in the document with an X delete symbol allowing
users to delete the label.

Delete field label mapping with validation
pattern:

In spite of deleting a field label, the validation
pattern that was assigned to the field remains in
place.

Delete option ('X') when bounded box
reaches space limit:

If the label/field value bounded box in the
document view covers a bigger area, extending to
the edge of or beyond the document view, the 'X'
delete symbol appears in the nearest corner of the
box.

Прим.:  The field value box in the middle panel is disabled and users cannot enter text manually.

Designer validation patterns
IQ Bot Designer allows you to validate a field and table column against a set of predefined parameters so
that you can be warned if any mismatch is found during data digitization process.

Validate a field or table

Validate a field or table column against the following predefined parameters of validation options:
• Start With / End With
• Шаблон
• Списки
• Formulas

IQ Bot classifies documents into groups based on similar content, structure, and layout, which is easily
identifiable. The sample documents for training are chosen based on these criteria as well. When you
launch the Designer to train your learning instance, IQ Bot loads and displays a sample document from
each classified group in the document pane.
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Tip:  In the Designer set the validation parameters by defining any field and or table column during
document training.

Starts With and Ends With
While all validations can be set at the time of Design definition, you can set Starts with/Ends with and
Pattern validations during training.
To validate whether data in a field starts or ends with a certain value, use the Starts With and Ends
With validation option fields. While defining the design of a field or table column, you can specify whether
the data is part of the selected field.
• Start with a certain value using a Starts With field
• End with a certain value using an Ends with field

If the Start With value is "IN" and extracted value is "1N7646464", then validation fails. While if End With
value is 2017 and the extracted date value is 10-Aug-2017, the validation passes.

Шаблон
A pattern helps define an acceptable format for data.
Validate data in the field or table column against a specific pattern. While defining the field or column in
the Design view, specify a pattern of the data in the selected field.
Specify a pattern for date, number, or text fields based on the different available patterns. Reference the
tables below for common examples:

Текст

Field Pattern Notes Description

Эл. почта ^([a-z0-9_
\.-]+)@([\da-z
\.-]+)\.([a-z\.]
{2,6})$

This regular expression
validates emails like
john@ado.com.

The Email field
supports regular
expressions.

Номер телефона ^(\(?\+?[0-9]*
\)?)?[0-9_\-
 \(\)]*$

This regular expression
validates phone
numbers like (+64) 38
3235393.

The Phone Number
field supports regular
expressions.

Website ^([a-zA-
Z0-9]+(\.[a-zA-
Z0-9]+)+.*)$

This regular expression
validates websites like
www.domain.com.

The Website field
supports regular
expressions.

Number string ^[0-9]{1,45}$ This regular expression
validates a string with
numbers 0 - 9 and limit
length to 45.

The Number string
field supports regular
expressions.

Alpha-numeric ^[A-Za-z0-9_@./
#&amp;+-]*$

This regular
expression validates
a string containing
alphanumeric values
like INV-001.

The Alpha-numeric
field supports regular
expressions.
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Число

Field Pattern Notes Description

Number string ^[0-9]{1,45}$ This regular expression
validates a string with
numbers 0 - 9 and limit
length to 45.

The Number string
field supports regular
expressions.

Auto Correction for date and number fields

This is one of the built-in features of IQ Bot for date and number format types. It performs automatic
validation and correction based on the defined pattern , even when the date/number in the scanned
document is incorrect.

Note:  Auto correction is only supported for special patterns.

The following table illustrates the auto-correction of an incorrect date and numbers by IQ Bot.

Incorrect OCR
value

Pattern Auto-Correction Description

DATE 12 F3B 2 0 1 5
15 10-2015

dd mmm yyyy
dd-mm-yyyy

12 FEB 2015
15-10-2015

In the first
example, IQ Bot
auto corrects
incorrect OCR
"F3B" to "FEB".
In the second
example, IQ Bot
auto corrects
"15 10-2015"
to"15-10-2015".

ЧИСЛО 123 4567
12.34,S67.12

9999999
99,99,999.00

1234567
1234567,12

In the first
example, the extra
space between
"3" and "4" is
deleted after
validation against
the pattern.
In the second
example, the
alphabet "S" is
corrected as "5".

Note:  English language numeric value with at least one digit to the left and two consecutive digits to the
right (for example, 1.23) gets auto corrected if there is a space found between the decimal and the digits.
For example, values 1 . 23 or 1. 23 or 1 .23 get auto corrected to 1.23.

To use this feature, add Pattern (in validation options) to the selected date and number format fields.
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Special number patterns

A special pattern consists of a Prefix, a Number Pattern, and a Suffix. Use for each is explained as follows:
• Prefix: Any symbol or a text string that is appended before the Number Pattern.
• Suffix: Any symbol or a text string that is appended after the Number Pattern.
• Number Pattern: Number pattern has two parts:

• Integer-part:
They are represented by nines (9s).
The 9s in the integer part represents integer pattern and separators such as commas, spaces, and
so on.

• Fractional part
They are represented by zeros.
If you need two fractional number, then it will be represented by two zeros.
Specifying fractional part is optional.
Format of numbers defined for validating numeric data.
IQ Bot supports prefixes and suffixes to make processing and validation of data easier. Specifying
a suffix and prefix in the pattern and in the numeric fields is optional. Even if you do not specify
the suffix or prefix, IQ Bot auto corrects and includes the required currency symbols and units of
measure for the numeric fields as prefix or suffix. If you specify the currency symbols and units of
measurements in the pattern and in the numeric data, IQ Bot deletes the currency symbol and unit
of measure from the data.

Note:  IQ Bot automatically recognizes these currency symbols: $, ¥, £, ₹, €, Rs, USD,
 EUR, CAD, AUD, GBP, and INR. We recommend specifying valid currency symbols in the data.

IQ Bot supports prefixes and suffixes to make processing and validation of data easier. Specifying a suffix
and prefix in the pattern and in the numeric fields is optional. Even if you do not specify the suffix or
prefix, IQ Bot auto corrects and includes the required currency symbols and units of measure for the
numeric fields as prefix or suffix. If you specify the currency symbols and units of measurements in the
pattern and in the numeric data, IQ Bot deletes the currency symbol and unit of measure from the data.

Note:  IQ Bot automatically recognizes these currency symbols: $, ¥, £, ₹, €, Rs, USD, EUR,
 CAD, AUD, GBP, and INR. We recommend specifying valid currency symbols in the data.

Examples of special number patterns

Шаблон Пример

Supported patterns Supported format for numeric patterns:
• Decimal (India)
• Decimal (US, UK, Australia and others)
• Number (India)
• Number (US, UK, Australia and others)
• Normal Decimal
• Normal Number
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Шаблон Пример

9999999,00 2597,23

9999999,00 7562597,23

9 999 999.00 2 597.23

9 999 999,00 7 562 597,23

9999999,00 2597,23

9999999,00 7562597,23

99,99,999.00 75,26,569.56

$ 9.999.999,00 $ 7.562.597,23

$9 999 999.00 $7 562 597.23

9 999 999,00 $ 2 597,23 $

€ 9999999,00 € 7562597,23

€9999999.00 €7562597.23

99,99,999.00 € 75,62,597.23€

EUR 9,999,999.00 EUR 7,562,597.23

EUR9 999 999.00 EUR7 562 597.23

9999999,00 EUR 62597,23 EUR

9.999.999.00 62.986.51

9, 999, 999. 00 232, 510. 68

Special date patterns

Supported date separators include /(forward slash), –(dash), space, .(dot), and ,(comma).
• d - Numeric day of the month, from 1 through 31 (eg. 5, 15 etc.)
• dd - Numeric day of the month, from 01 through 31 (eg. 05, 15 etc.)
• m - Numeric month (eg. 1 for January)
• mm - Numeric month (eg. 01 for January)
• mmm - First 3 letters of the month (eg. NOV for November)
• mmmm - Full name of the month (eg. June)

Examples of special date patterns

Шаблон Пример

mm-dd-yy 01-31-18

mmm-dd-yyyy Jan-31-2018

mmmm dd, yyyy 2018-1-31

Mmmm d, yyyy 2018-1-09
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Шаблон Пример

D M YY 9 5 15

D MM YY 9 11 15

D MMM YY 7 MAR 15

D MMMM YY 7 MARCH 15

M DD YYYY 5 05 2018

D/MM/YY 2018-5-05

M/D/YY 2015-9-05

DD / M / YYYY 05 / 9 / 2018

MMM / DD / YY MAR / 05 / 18

D-MMMM-YY 09-APRIL-18

M-D-YY 5-5-18

MM-D-YY 11-5-18

MMM-DD-YYYY NOV-13-2018

DD - M - YYYY 13 - 5 – 2019

MMMM - DD - YY OCTOBER - 05 – 18

D.MMMM.YYYY 05.APRIL.2018

MMMM.DD.YYYY APRIL.05.2018

D . M . YY 5 . 5 . 18

D . MM . YY 5 . 05 . 18

DD . MMM . YY 05 . JUL . 18

M . DD . YYYY 5 . 11 . 2018

MMMM . DD . YY MAY . 13 . 13

YYYY-MM-DD 2018-1-27

YYYY/MM/DD 2017/07/27

Списки
While defining a field or table column in the Design view, you can specify a list as part of validation option
for a selected field or table column. The extracted value of the field is validated against this predefined list
during Preview and Test Run.
You can only specify list validation when format of field or table column is "Text". If the lookup returns
multiple values for a word, the value is not auto corrected and the validation fails.
To specify list validation, do the following:
1. Select the validation type as List from the Validate drop-down menu.
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2. Type a predefined list and click Define to save.
Each value in the list should be in a separate line.
If the extracted value does not match any value in the predefined list, the field is considered to have
failed validation.

Formulas
Specify a formula as part of validation options for a selected field or table column. Use basic arithmetic,
comparative, logical, and functional operations.

Tip:  We recommended using functional operators instead of mathematical operators when validating
fields and tables for better accuracy.

When formulating an expression remember the following:
• All function names must be in capital letters.
• All formulas must result in either a true or false validation.
• Field and column names are case sensitive when used within formulas. If field is defined as Qty in

design, using qty or QTY in formula results in an invalid formula.
• For variable declaration or manipulation, ensure not to use certain keywords that are reserved for

formulating an expression, including SUM, SUB, DIV, MUL, COLSUM, IF.

Mathematical Operators

Operations Description Syntax

+ Addition Field/Column_Name1 + Field/
Column_Name2

- Subtraction Field/Column_Name1 - Field/
Column_Name2

* Multiplication Field/Column_Name1 * Field/
Column_Name2

/ Деление Field/Column_Name1 / Field/
Column_Name2

Comparative Operators

Operations Description Syntax

== Equal To [Current Field/Column Name]
== [expression comprised of
one or more field/column name
or fixed numeric values]
For example, AMOUNT ==
MUL(QUANTITY, UNIT_PRICE)
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Operations Description Syntax

>= Greater than or Equal To [Current Field/Column Name]
>= [expression comprised of
one or more field/column name
or fixed numeric values]
For example,
TOTAL_BILL_AMOUNT >=
AMOUNT_PAID

<= Less than or Equal To [Current Field/Column Name]
<= [expression comprised of
one or more field/column name
or fixed numeric values]
For example, AMOUNT_PAID
<= TOTAL_BILL_AMOUNT

> Больше [Current Field/Column Name]
> [expression comprised of one
or more field/column name or
fixed numeric values]
For example, BILL_AMOUNT >
0

< Меньше [Current Field/Column Name]
> [expression comprised of one
or more field/column name or
fixed numeric values]
For example,
DISCOUNT_PERCENTAGE <
100

!= Not Equal To [Current Field/Column Name] !
= [expression comprised of one
or more field/column name or
fixed numeric values]
For example, DEBIT_AMOUNT !
= 0
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Logical Operators

Operations Description Syntax

&& And: Field/Column is valid if all
conditions are true

<Current Field/Column Name>
<operator 1> <expression
1> && <Current Field/
Column Name> <operator 2>
<expression 2>
For example,
DISCOUNT_PERCENTAGE >=
0 && DISCOUNT_PERCENTAGE
<=100

|| Or: Field/Column is valid if any
one of the given conditions is
true

<Current Field/Column Name>
<operator 1> <expression
1> || <Current Field/Column
Name> <operator 2>
<expression 2>
For example,
DISCOUNT_PERCENTAGE >= 0
|| DISCOUNT_PERCENTAGE ==
'Net'

! Not: Converts a true expression
to false and also the other way
round

!<expression>
For example, !(AGE < 18) ==>
valid when AGE is not less than
18

Functional Operators

Operations Description Syntax

СУММА Summation: gives result of
addition of one or more field/
column/fixed-number values

SUM(n1,n2,....,nN)
For example, SUM(SUB_TOTAL,
SERVICE_TAX,
EDUCATION_CESS) ==>
equivalent to SUB_TOTAL
plus SERVICE_TAX plus
EDUCATION_CESS

SUB Subtraction: gives result of
subtraction of one or more
field/column/fixed-number
values from the first specified
value

SUB(n1,n2,....,nN)
For example, SUB(SUB_TOTAL,
TOTAL_DISCOUNT,
ADJUSTMENTS) ==>
equivalent to SUB_TOTAL
minus TOTAL_DISCOUNT minus
ADJUSTMENTS
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Operations Description Syntax

MUL Multiplication: gives result of
multiplication of one or more
field/column/fixed-number
values

MUL(n1,n2,....,nN)
For example,
MUL(QTY_IN_BOX,
UNIT_PRICE, SHIPPED_BOXES)
==> equivalent to
QTY_IN_BOX multiply-with
UNIT_PRICE multiply-with
SHIPPED_BOXES

DIV Division: gives result of
division of one or more field/
column/fixed-number values
from the first specified value

DIV(n1,n2,....,nN)
For example, DIV(AMOUNT,
SHIPPED_BOXES, UNIT_PRICE)
==> equivalent to AMOUNT
divide-by SHIPPED_BOXES
divide-by UNIT_PRICE

COLSUM Sum of a given Column
in a table: gives result after
evaluating given expression for
each row of specified table and
adding them all together

COLSUM("<table-name>",
"<expression to evaluate for
each row of specified table-
name>")
For example, FINAL_TOTAL
== COLSUM("LINE_ITEMS",
"MUL(QTY, UNIT_PRICE)")
Say there are 3 rows for
table LINE_ITEMS, then
FINAL_TOTAL should be equal
to MUL(QTY1, UNIT_PRICE1)
+ MUL(QTY2, UNIT_PRICE2) +
MUL(QTY3, UNIT_PRICE3)
where, QTY1 is QTY value in
row 1, similarly UNIT_PRICE1
is UNIT_PRICE value in row
2, and so on for other rows as
well.

Adding custom logic to improve automatic extraction in production
Enter the logic in the IQ Bot Designer to improve text extraction and validation, and to reduce the number
of documents entering the Валидатор that requires RPA post processing.

Обзор

For Automation 360 IQ Bot Cloud, there is an identified list of Python libraries and packages that are
safe to use for the Custom Logic feature. Use only these packages to ensure security for your cloud
infrastructure, file systems, databases, and network resources: List of Pandas Libraries which are supported
and not supported on Automation 360 IQ Bot (A-People login required)
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Keep in mind the following:
• Custom logic executes in a sequential order across all tables and fields.
• Applying custom logic might increase the extraction time per document.
• Automation 360 IQ Bot validation rules apply over the extracted values processed by the custom script.
• Custom script only works on the extracted data and does not influence the OCR extraction quality.
• Always test your Python script before processing documents in a learning instance in production

The custom logic feature helps clean up extracted values ahead of the validation step but does not replace
all the post-processing currently done using the TaskBot. In addition to adding inline scripts, users can use
the Python scripts in a central location, import those as modules, and call functions to reduce the amount
of Python code at the field or table level.

Restriction:  If the number of characters in the Python code along with other information exceeds 32000,
and when this code is sent to the back-end as a Windows runtime argument for the process, the execution
fails, and does not display any error message.

Resources

To learn more, search for Using Custom Logic in IQ Bot course in Automation Anywhere University: RPA
Training and Certification (A-People login required).

Следующий шаг
Using scripts, in the IQ Bot Designer add the Form fields and Table fields.

Поля формы
Add scripts in Designer for form fields.
The List validation via external file can be implemented as a part of the field custom logic using python
scripts directly in the Designer.
1. In the IQ Bot Designer, left-hand panel, highlight a form field whose extraction/validation you aim to

improve further.
2. In the middle panel, scroll down to Field options > Logic.
3. In that Logic section, toggle between fullscreen and smallscreen for ease of use.
4. Add code to modifyIQ Bot's extracted text value. See example below:

# variable that stores the value: field_value

# import the Python regular expression library, re
import re

# call the regular expression library's method, findall, to extract the
 date value only
field_value = re.findall(r'\d{2}-\d{2}-\d{4}', field_value)[0]

5. Select Test Run to test your script and see the results before vs. after.

value_before: 2018/11/09 B210
value_after:  2018/11/09
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Поля таблицы
Add scripts in Designer for table fields.
1. In IQ Bot Designer, left-hand panel, highlight Table/section settings for the table whose

extraction/validation you aim to improve further.
2. In the middle panel, scroll down to Logic.
3. In the Logic section, toggle between fullscreen and smallscreen for ease of use.
4. Add code to modify the extracted table values, which are stored as a Python dictionary in a user

variable called table_values. See example below.
Each row has a Guid (Global unique identifier), which allows IQ Bot to auto track rows that are added
and deleted. If you add a row, you need not enter a Guid. IQ Bot will handle this automatically.

# variable that stores the value: table_values

# convert from dictionary to dataframe
df = pd.DataFrame.from_dict(table_values)

# print dataframe before update
print(df)

# Item_Description: drop rows with a missing value
df = df[(df["Item_Description"] != "")]

# Quantity: extract first part of the string, the numeric part only
df['Quantity'] = df['Quantity'].str.split(' ', 1).str[0].str.strip()

# print dataframe after update
print(df)

# convert back from dataframe to dict to override what IQ Bot stores
table_values = df.to_dict()

5. Select Test Run to test your script and see the results before vs. after.

      Item_Description                                  Guid        
 product_id     Quantity Item_Total
0         wafer, NO172  43ea78f4-7b9b-413a-83ce-89d671478d6c  2
 COMS5A-18090220     4.00 PCS   5,840.00
1  Visual Iaspection +  cc774f5f-2507-4a15-8e45-7b2abf84fabe             
            1.00 EA      65.00
2                       6bddfed1-2359-4305-a0ac-a1769c113bfb   5% VAT :
 Total -  4.00PCS GR:   5,905.00
3                       2dc642a7-8e6e-4bc6-9672-85afff8c21db           
 Total -         KGD:       0.00

      Item_Description                                  Guid        
 product_id     Quantity Item_Total
0         wafer, NO172  43ea78f4-7b9b-413a-83ce-89d671478d6c  2
 COMS5A-18090220     4.00       5,840.00
1  Visual Iaspection +  cc774f5f-2507-4a15-8e45-7b2abf84fabe             
           1.00          65.00

6. If you select See extraction results or save the бот, your script is saved.
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Use cases and examples
These are some use cases the Designer script feature supports.
For examples of user scripts and use cases, see: IQ Bot custom logic use cases and examples

Following are some use cases:
• Query an extracted value vs. a database in an ERP system to validate values.
• Extract "0123456" from "PO 0123456".
• Remove table rows that contain "Page x of y".
• Extract the currency from one table field (for example: Item Total) and save in an empty table field.
• Extract the product number from a table field (for example: Item Description).
• Extract the zip code from an address.
• Query a REST service (for example: add NLP, retrieve data from an outside system, and so on).
• Return a Boolean yes/no value on whether handwriting exists for a field.

Pre-installed Python packages
To facilitate ease of use and consistent behavior across servers, IQ Bot auto installs Python v3.11.0 and
some popular Python packages mentioned as follows.

Table 7: Pre-installed Python packages

Main package Версия URL-адрес

difflib In-built Python with installer https://docs.python.org/3/library/
text.html

io In-built Python with installer https://docs.python.org/3/library/
io.html

re In-built Python with installer https://docs.python.org/3/library/
text.html

sqlite3 In-built Python with installer https://docs.python.org/2/library/
sqlite3.html

строка In-built Python with installer https://docs.python.org/3/library/
text.html

stringprep In-built Python with installer https://docs.python.org/3/library/
text.html

sys In-built Python with installer https://docs.python.org/3/library/
sys.html

textwrap In-built Python with installer https://docs.python.org/3/library/
text.html

unicodedata In-built Python with installer https://docs.python.org/3/library/
text.html

Дата/время 4,3 https://pypi.org/project/DateTime/

pandas 0.24.2 https://pypi.org/project/pandas/

inflection 0.3.1 https://github.com/jpvanhal/
inflection

dateutils 0.6.6 https://pypi.org/project/dateutils/
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Main package Версия URL-адрес

tabulate 0.8.3 https://pypi.org/project/tabulate/

numby 1.16.4 https://pypi.org/project/numpy/

json 2.0.9 https://docs.python.org/3/library/
json.html

requests 2.22.0 https://github.com/kennethreitz/
requests

psycopg2 2.8.3 https://pypi.org/project/psycopg2/

pymongo 3.8.0 https://pypi.org/project/pymongo/

pyodbc 4.0.26 https://github.com/mkleehammer/
pyodbc

opencv-python 4.1.0.25 https://pypi.org/project/opencv-
python/

Pillow 6.0.0 https://github.com/python-pillow/
Pillow

cx_Oracle

Note:  As of Сборка 16685,
this module is replaced by
oracledb. See Upgrading from
cx_Oracle 8.3 to python-oracledb

7.1.3 https://github.com/oracle/python-
cx_Oracle

oracledb 1.2.1 https://github.com/oracle/python-
oracledb

Python Arabic Reshaper 2.0.15 https://github.com/mpcabd/python-
arabic-reshaper

Additional Python packages
To allow further empowerment, you can add more Python libraries for use in IQ Bot.
1. Open the Command Prompt.
2. In the Command Prompt, change directory to IQ Bot's Python dictionary. Пример. C:\Python354-

x86-IQBot.
3. Install your Python package there. For example: pip install PyArabic.
4. In IQ Bot Designer > Logic, you can import and use that Python package.
5. If step 4 does not work, then stop/uninstall and then install/start services.

Extract data using magnetic ink character recognition
Use the magnetic ink character recognition (MICR) OCR feature with ABBYY FineReader Engine version
12.2 support to extract MICR data from financial checks.

Note:  Documents in Non-Latin based languages cannot be processed if MICR is enabled on ABBYY
FineReader Engine OCR version 12.3 and 12.4.
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• Ensure that ABBYY FineReader Engine is installed in the plug-ins folder: \OCR Plugins\ABBYY SDK
\12\. . ..

• From the C:\Program Files (x86)\Automation Anywhere IQ Bot
 (version)\Configurations folder, open the Settings.txt file, change OCREngine=Tesseract4
to OCREngine=Abbyy, and save the file.

Note:  A system restart is not required.

The MICR feature is supported with ABBYY FineReader Engine versions 12.2 .
1. Set ABBYY FineReader Engine in your settings.txt file as the primary OCR engine.
2. Navigate to the IQ Bot\Configurations\AbbyyImagePreProcessingSettings.json file.
3. Update these parameters:

• TextTypes = 129
• DetectTextTypesIndependently =true

The MICR feature is activated in the system.

• Create a learning instance and add form fields to extract MICR data from financial checks such as
MICR and Pay to fields.

• Scan and upload a check to IQ Bot for training. In production, upload the financial checks for accurate
MICR data extraction.

• In the Designer, map the MICR data in the financial check for extraction.
• In production, upload the financial checks for accurate MICR data extraction.

Set learning instance to Production
After you have trained a learning instance on Staging to extract data from documents with high accuracy,
you can move the learning instance to Production. This enables you to deploy the learning instance on
production documents for real time data extraction.
Use the Set instance to production button to move a learning instance to Production. When you move
a learning instance to the Production environment, a confirmation message appears. To confirm, click Yes,
send to production. Learning instances in the Production environment are identified by the Production
label next to their name.

Tip:  You can also use the My Learning Instances page to move a learning instance to Production.

Note:  During the production process, you must not move the learning instances or bots from Staging to
Production or vice-versa.

Manage learning instances
A learning instance is an IQ Bot structure that describes the data in a single document type, for example
an invoice. It contains information such as the language used in the document and the fields to extract.
A learning instance can be either in staging or production mode. These modes determine whether the
learning instance is a draft or live version.

Staging In the staging mode, you can create and edit
learning instances, upload sample documents,
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and train боты to extract data from the sample
documents you uploaded. You can test and improve
the accuracy of a learning instance and its боты
before deploying it to production mode.

Note:  Because the data generated by learning
instances in the staging mode is based on sample
documents, it is kept separate from data pertaining
to learning instances in production mode. For
example, sample documents are not counted
against your organization's purchased pages.
Подробнее см. в разделе Обзор информационной
панели on page 2548.

Производство In the production mode, a learning instance can
automatically process real business documents,
extract data, and send documents requiring manual
validation to the validation queue.

To find out which mode a learning instance is in, navigate to the LEARNING INSTANCES tab, where the
My learning instances page displays the learning instances in the environment. Each learning instance
has a toggle in the Actions column, which indicates whether it is in staging (toggle to the left and is
colored gray) or production (toggle to the right and colored orange).

Based on the mode that a learning instance is in, different user types contribute to IQ Bot. For example, in
the staging mode, the Data engineer creates learning instances and the Bot builder builds supporting RPA
боты, and in the production mode, the Validator manually corrects the fields in the documents that IQ Bot
could not process. To learn more about how each user contributes to IQ Bot, see IQ Bot process overview.

Note:  The following are the file size restrictions in each stage:
• In staging, you can upload a maximum of 150 documents of 10 MB file size per learning instance.
• In production, you can upload a maximum of 50 MB file size per document. However, the maximum

number of documents allowed per learning instance depends on the license.
• There are no limitations on the number of pages per document in a pdfbox OCR.
• You can upload 60 pages per document in an image-based OCR.
• With the Tesseract4 OCR, there is a known limitation that restricts the number of pages per document

to fewer than 60 pages.
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The learning instance lifecycle

The staging and production modes are independent from the IQ Bot environment when it comes to the
traditional DevOps workflow of separate development, testing, and production environments. A learning
instance can be in either mode in any of the environments in the development life cycle.

Note:  When you transfer a learning instance, it remains in the mode in which it was exported. For
example, if you export a learning instance in staging mode from the development environment and import
it to the testing environment, the learning instance will still be in staging mode and it will not perform
document processing automatically.

The following image shows the typical lifecycle of a learning instance:

You can transfer learning instances across environments by using the Migration Utility. This helps you to
avoid having to recreate similar learning instances and better manage the lifecycle of the associated боты.
Подробнее: Migrate learning instances on page 1362.

Ротация внешних ключей
Control Room поддерживает использование CyberArk для сохранения ключей для шифрования и
расшифровки данных IQ Bot. A user with the AAE_Администратор IQ Bot role can change the object
name in IQ Bot to start the key rotation process.
• IQ Bot должен быть подключен к CyberArk во время установки. См. раздел Установка IQ Bot в

пользовательском режиме on page 1086.
• Обновите пароль в хранилище CyberArk для генерации нового ключа. Обратите внимание на

новое имя ключа. Вы будете указывать его в IQ Bot.

1. Выберите Администрирование > Ротация ключей.
Большинство полей на странице Ротация ключей автоматически заполняются сведениями о
подключении, которые вы указали при установке.

2. В поле Имя объекта укажите имя нового ключа от CyberArk.

© 2023 Automation Anywhere. All rights reserved.     2544



    Automation Anywhere - Оцифровка

3. Щелкните Ротация ключей.
IQ Bot извлекает новый ключ из хранилища CyberArk и шифрует данные этим новым ключом. По
завершении процесса шифрования появится сообщение.
Если процесс шифрования не удался, используйте синхронизатор ротации ключей для
восстановления после ошибки.

Use the IQ Bot Валидатор
Use the Валидатор to manually validate documents from which IQ Bot could not extract data.
When IQ Bot processes documents in a learning instance that is in production mode and encounters one of
the following scenarios, IQ Bot sends that document to the Validation queue.
• Data is not readable, such as blurry text or dark background.
• Data is missing from a required field.
• Document failed an automated processing rule.
• Fields did not meet the set optical character recognition (OCR) confidence threshold.

Note:  To learn more about how field-level OCR confidence can be used to improve the quality of STP
output, see Improve output quality using OCR confidence on page 2519.

A user with the AAE_Валидатор IQ Bot role opens the Валидатор window, where they correct the
flagged fields.
Once all the fields in the document are corrected, IQ Bot finishes processing the document and exports the
data to a .CSV file in the Learning Instance success folder.

Note:  If a document required manual validation, it is excluded from the straight-through processing (STP)
metric. For more information on the dashboard metrics, see Обзор информационной панели on page
2548.

As you work on a document in the Валидатор queue, if you leave the Валидатор queue or log out of IQ
Bot, the lock on the document is released, allowing other users to access or validate the document.

Валидатор interface overview

The Валидатор interface opens with the first document from the validation queue. The data requiring
validation distinguished with red text or outlined in red boxes.

Note:  An empty page with a notification message appears in the following scenarios:
• If no files are available in the validation queue.
• If a file does not exist in the validation queue.
• If another user is working on the remaining file in the validation queue.
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1. Provide the values for fields IQ Bot could
not extract

Click the empty text field, then select the blue-
bounded box in the document that contains the
data to extract. After you select a box, the data is
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highlighted in yellow and a green outline appears,
which you can resize or reposition to include all the
data that you want to extract.

2. Fields awaiting validation are outlined in
red

In the example above, the table fields Item total
and Quantity require manual entry.

3. Add or delete a row To insert or delete a row, hover over the ellipses to
show the icons for adding or deleting table rows.

4. Mark document as invalid Removes the document from the validation queue
and saves a copy of the document to the Invalid
folder. Click here to mark a document as invalid,
then select from the following reasons:
• Fields missing
• Tables missing
• Wrong values

5. Сохранить текущий документ After you have validated all the fields, click here so
IQ Bot can finish processing this document.

6. Skip to next file Skip a file without correcting the errors in the
current document.

Linked tables in the Валидатор

Some pages in a document might contain more than one table. When there is a relationship between the
tables, such as in the example page below, where a parent table contains patient information and child
tables contain additional information related to that patient, these are called linked tables.
In the example page below, the red box outlines the parent table and each of the blue boxes outline a
child table.
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To successfully validate a page with linked tables, add the fields from the child tables to same table-
repeated section as the parent table.
If shared fields between the linked tables do not match values, the Валидатор does not let you complete
validation and save your changes. This functionality helps avoid manual validation errors that can occur
when there is a mismatch of field values between the parent and child tables. The Валидатор shows an
error message and prevents the save.

Note:  In Валидатор, if you mark an already corrupted document as invalid then that document is lost in
the IQ Bot system. Instead, you will see a placeholder image and you must refresh the page to go to the
next document. This applies to single page as well as multi-page documents.When the entire multi-page
document is deleted or corrupted, you will not be able to navigate between the pages. If you click the next
page button, then the Loading document screen is displayed.

Using the Валидатор

Open the Валидатор user interface from the LEARNING INSTANCES tab. If a learning instance contains
documents that require validation, there will be a document icon with a red exclamation mark in the
Actions column. Click the document icon to launch the Валидатор.

Note:  Only users with an assigned Валидатор role can view the Validation page. Подробнее см. в
разделе IQ Bot user personas and roles on page 2493.

Обзор информационной панели
Информационная панель обобщает отчет о работе и предоставляет информацию об обработке
документов в графическом формате.
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Отчет появляется, когда вы входите в систему IQ Bot. Отображается информация о классификации
документов, сквозной обработке (STP) и точности, а также о проверке человеком сведений о
действиях для конкретного обучаемого экземпляра. Это позволит вам сосредоточиться на областях,
требующих внимания.
Информационная панель IQ Bot разделена на две основные области.
• Мое общее количество
• Мои обучаемые экземпляры

Область «Мое общее количество»

Мое общее количество — это отображаемая на информационной панели область, которая дает
краткий общий обзор статуса всех обучаемых экземпляров в рабочей среде.
В области Мое общее количество просмотрите приведенную ниже информацию.
• Документы обработаны. Общее количество файлов, обработанных в рабочей среде.

Note:  Если файл поврежден и не может быть открыт, он не учитывается в этом подсчете.

• Страницы приобретены. Количество страниц, приобретенных за текущий лицензионный
период.
Например, если 4000 страниц были приобретены до 31 декабря 2020 года и еще 20 000
страниц были приобретены в период с 1 января 2021 года по 28 февраля 2021 года, измерение
приобретенных страниц показывает количество 20 000 страниц, а не 24 000. Это связано с тем,
что 4000 страниц были приобретены до истечения срока действия лицензии.

Note:  This metric is visible only to users with the AAE_Администратор IQ Bot role or a custom
role with the View administration permission.

• Страницы загружены. Количество страниц, загруженных в обучаемый экземпляр в рабочей
среде за текущий период действия лицензии. When the license is renewed, the value reverts to zero.
Это измерение отличается от измерения обработанных документов, поскольку один документ
может содержать несколько страниц. Кроме того, подсчет на основе измерения включает
загруженные страницы, обработка которых не была завершена.

Note:  In releases prior to Automation 360 v.23, this metric reflected the number of pages uploaded to
learning instances in the production environment from the time of IQ Bot installation.

• Сквозная обработка (STP). Процент от общего числа загруженных файлов, которые были
успешно обработаны без ручного вмешательства.

• Точность. Точность полей, которая представляет собой процентное значение точно
идентифицированных полей. Сюда входят поля, уровни доверия оптического распознавания
символов (OCR) которых превышают заданный порог доверия.

Область «Мои обучаемые экземпляры»

Просмотрите сведения о созданных вами обучаемых экземплярах, которые находятся в
промежуточных и рабочих средах.
Просмотрите информацию об обучаемых экземплярах в промежуточной среде.
• Имя обучаемого экземпляра
• Область или тип документов. Например, счета-фактуры и квитанции.
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• Количество документов в обучаемого экземпляре
• Графическое представление обучаемых документов, показывающее подробные сведения в

процентах

Просмотрите информацию об обучаемых экземплярах в рабочей среде.
• Количество обработанных файлов
• Процент сквозной обработки (STP) файлов, которые были успешно обработаны без ручного

вмешательства
• Точность поля в процентах

Important:  Иногда количество документов на информационной панели и на странице со сводными
сведениями об обучаемых экземплярах не совпадает с количеством документов, поданных на
обработку. Это может произойти, когда документы классифицируются по группам, которые не
относятся к производству. Документы в этой категории не обрабатываются (преднамеренно),
что приводит к несоответствию между количеством обработанных документов и количеством
всех документов. В таком случае, если эти группы перевести в производство, общее количество
документов будет совпадать.

Performance report page
The performance report page displays the details of a learning instance in the production environment.
Navigate to My learning instances > Production button to view the Performance report page
showing details of all learning instances in the production environment.

Note:  The Performance report page is not available for learning instances that are in the staging
environment.

The top right corner of the performance report page displays the percentage of bots trained for the
learning instance. The following is an example of how to interpret the percentage information.

Cathy has uploaded 10 documents and has created three bots for the learning instance:
• Bot1
• Bot2
• Bot3

Of these, three documents are a part of Bot1, four documents of Bot2, and three documents of Bot 3.
When Cathy sets Bot1 into the production environment, the label displays 33% as the percentage of bots
trained for the learning instance, which means that 3 out the 10 (33%) uploaded documents (for Bot1)
have been trained.

Performance report details
In the My learning instances area, click any displayed information to bring up the Performance report
page. The following sections describe the information for each displayed section of the performance report.

Instance totals and Processing results

The instance totals and processing results area shows the following information for a learning instance:
• Number of files uploaded for the learning instance – total number of files uploaded that need to be

processed.
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• Number of files processed for the learning instance - number of files that was processed by a bot.
• Number of files successfully processed for the learning instance – includes files that were successfully

processed by a bot without human intervention.
• Number of files sent to validation for the learning instance – files flagged with one or more errors that

need human intervention for review.
• Number of files validated for the learning instance – number of files that were reviewed by an individual

and the results were saved.
• Number of files marked as invalid for the learning instance – number of files that were reviewed by an

individual and marked as invalid.

Classification results

The Classification area provides a statistical display of the field representation graphically.

Accuracy results

The Accuracy area provides a graphical representation of the field types.

Валидация

The Validation area provides the following information:
• A statistical representation of the corrections made to individual fields during the process of validating a

document.
• A statistical representation of the average time spent to validate a group.

Custom domains in IQ Bot
A domain contains information about the language of the documents and the data fields that the
system extracts from the documents. The IQ Bot environment includes seven domains; users with the
AAE_Администратор IQ Bot role can also create and import custom domains to the Domains tab.
If your documents contain specialized fields, you can create a custom domain with these fields to make
learning instance creation quicker. Otherwise, the learning instance creator must manually define each
specialized field, every time they create a new learning instance.
For example, for documents from the pharmaceutical industry, you might add fields like prescription name,
dose, or delivery format to the custom domain. Likewise for financial industry documents, you might add
fields for margin, call price, or limit order.
The Domains tab displays all available domains for use in the system and their associated languages.
Besides out-of-box domains offered by IQ Bot, you can also create a custom domain and import it into IQ
Bot.
Create a custom domain (A-people login required)

When creating a learning instance using a custom domain:
• The languages assigned to the domain when creating the domain is displayed and is available for

selection from the Primary language of documents drop-down list.
• The fields that were selected when creating the custom domain are displayed in the Fields to extract

section of the create New instance page.
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You can import or export a domain using the Import or Export option in the Domains tab.

Прим.:  Domains are created and saved with the .dom extension in the system.

Совет:  Troubleshoot classification issue with Chinese language documents:
Classification issue with Chinese Invoices (A-People login required)

Import a domain

You import a domain for the following scenarios:
• Import a new domain.
• Import an existing domain from another system to your current system.

When you are ready to import a domain into your system:
1. Go to the system where you want the domain to be imported.
2. Click Import new domain in the Domains tab and select the .dom domain file in your local

machine that you want to import.
The domain import success message is displayed in the Domains tab.
The imported domain appears for the selection in the Document type drop-down list of the create
New instance page and is displayed in the domains list in the Domains page.

Export a domain

When you click the Export option next to a domain, it is exported to an output folder on your local drive.
The exported domain is encrypted and is created with a .dom filename extension.
You export an existing domain from one IQ Bot system to import to another.
To export a domain from your IQ Bot system, do this: In the Domains list page, click the Export option
next to the domain you want to export.
The system displays a success message for the exported domain.
The file is exported to a local output folder on your machine with a .dom filename extension.

Прим.:  The domain files are encrypted for security.

Current limitations to the domain import and export actions

Важное замечание:  Import or export of domains is independent of the migration action in the
Migration Utility feature.

When you migrate learning instances that were created using a custom domain from one system to
another, the field names and IDs must be the same in the target machine as well. Otherwise, even though
the learning instances are imported, the custom domain will not be imported and the associated field
names and IDs for the custom domain will not work in the imported learning instance. If you run the
imported learning instance on documents, the documents will not be classified.
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Even if you import the custom domain to your new system, the field names and IDs will still not match as
these are automatically generated by the system. Hence classification will fail. This is the current limitation
of the Migration Utility feature using a custom domain.
Обходное решение. First import the .dom file to the target machine, then migrate the learning
instances. Move all learning instances to the staging environment, and test them before moving the
learning instance to the production environment.

Custom domain enhancements

Import custom domains in any order
When you migrate learning instances (created using a custom domain) from the staging server to the
production server, migration fails unless you import the different versions of the custom domain in the
same order as they were created.
As the capability to edit a custom domain to add additional fields and aliases was not available, the user
had to create a new domain and add the additional fields and aliases to it. Then the user had to assign
that new domain to the learning instance. So when the user wanted to use the new domain, they had to
re-import the original and the new domain to the production server in the order they were created in.
Importing custom domain to IQ Bot production (A-People login required)

From release Automation 360 Сборка 5322, this restriction does not exist.
• You can edit and update an existing custom domain multiple times, and import them to the production

server multiple times as well.
• You can import the custom domains in any order. The system successfully migrates the updated fields

(form or table), and field aliases (variations of field values found in the training documents, associated
with a field) to the production server.

Важное замечание:  Perform all edits or updates to a custom domain in the staging server before
importing it to the production server to avoid errors.

IQ Bot performs document classification based on the defined fields and aliases of the version of custom
domain used when the learning instance was created.
Editing the same custom domain (with additional fields) changes the version of the custom domain. For
new learning instances created using the new version of the custom domain, classification occurs on
the updated fields as well. The edited fields (whether form or table fields) are displayed in the learning
instance with a double asterisk next to them to help identify them.

Using IQ Bot for standard forms
Стандартные формы — это документы фиксированного формата, обычно содержащие большое
количество полей с очень незначительными или нулевыми отличиями от общего макета, которые
могут включать как рукописное, так и цифровое содержимое. IQ Bot позволяет извлекать данные из
стандартных форм.

Примеры стандартных форм: W-4 (Сертификат о налоговых скидках наемного работника при
начислении удержаний из заработной платы), бланк декларации на подоходный налог, акт
купли-продажи и договор о партнерстве. Из стандартных форм можно извлекать данные, настроив
и создав модель перед ее установкой в IQ Bot. Модель машинного обучения — это файл, который
можно использовать для обучения распознаванию среди документов шаблонов определенных типов.
Образец документа с набором данных можно использовать в целях обучения модели распознаванию
шаблонов.

© 2023 Automation Anywhere. All rights reserved.     2553

https://apeople.automationanywhere.com/s/article/Edit-a-custom-domain-IQBot-A2019


    Automation Anywhere - Оцифровка

На основе связанной роли или разрешения, определенного администратором Control Room, можно
создать обучаемый экземпляр, используя модель для извлечения данных из стандартных форм.

Note:  Users must have the Standard forms pages product license to upload documents for processing.
Подробнее см. в разделе Лицензии Automation 360 on page 1017.

The following workflow describes the various stages and procedures for setting up data extraction from
standard forms:
1. Evaluate your use case for standard forms.

Evaluate your use case on page 2555
2. Review the type of standard forms extraction service that fits your requirement.

Проверка службы извлечения on page 2557
3. Review the service implementation prerequisites.

Проверка предварительных условий внедрения on page 2558
4. Set up and configure an extraction service.

Настроить службу извлечения on page 2561
5. Configure IQ Bot for the selected extraction service.

Configure IQ Bot for extraction service on page 2562
6. Build a data extraction model.

Создание модели извлечения on page 2563
7. Log in to IQ Bot and create a learning instance.

Create a learning instance for standard forms on page 2564
8. Add validation rules for standard forms learning instance.

Define validation rules for standard forms learning instance on page 2565
9. Transfer the third-party extraction models

Transfer third-party extraction service models on page 2563
10. Move standard forms learning instance across different IQ Bot environments.

Transfer standard forms learning instance on page 2567
11. Upload documents in IQ Bot.

Upload documents for standard forms learning instance on page 2566
12. Validate the processed documents for standard forms learning instance.

Use the IQ Bot Валидатор on page 2545
13. Download the content extracted from standard forms.

Download extracted content on page 2567
14. Review the performance report and document processing information.

Обзор информационной панели on page 2548
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Workflow map: Click the following schematic image to view the Standard forms workflow in an

interactive visual format:
1.

Related concepts
IQ Bot user personas and roles on page 2493
Learn about the users that contribute to IQ Bot and the associated roles and licenses. IQ Bot users and
roles are defined in the Control Room.

Evaluate your use case
Content extraction models can be integrated into IQ Bot for extracting data from specific type of
documents.
Before you proceed further with standard forms, evaluate your use case to determine if the content
extraction from standard forms suits your requirement. Use the following questions as a guide to
determine whether your use case needs Standard forms processing

What are standard forms? Fixed format type documents that have a defined
template, with very little or no variation in the
overall layout. Standard forms are also known as
structured documents, are generally characterised
by high density of information, and are typically
official or legal forms. The following table illustrates
some examples of standard forms:
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Tax form Medical form Legal form

Does the layout of your documents vary
across vendor?

If yes, then this use case for content extraction
using standard forms is not the best option.

Are the positions of the various data
elements (checkboxes, tables, and so on)
fixed in your documents?

If no, then these are not standard forms and this
type of content extraction is not suitable.

Is the document a dynamic form? For
example, you have documents where the
values depend on other data elements.

If yes, then content from such documents cannot
be processed using standard forms content
extraction.

Is the document in a supported language? См. раздел Azure Form Recognizer Supported
Languages. If no, then the document cannot be
processed as a standard form.

Does the documents have repetitive sections? If yes, then this is not a standard forms use
case. However, if there are a fixed number of
such repetitive sections that do not vary between
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documents, then it can be processed as a standard
forms.

Does your documents contain tables that
have a different number rows and columns?

If yes, then these documents cannot be considered
as standard form. The number of rows and columns
have to be fixed for standard forms.

Can document layouts that vary per year be
considered as standard forms? For example, a
W-4 document in 2020 and W-4 document in
2021?

If the document layout does not vary within the
same year or vary across organizations, then it
can be considered as standard forms. If there
are layout variations across years, then different
standard form models must be used to process
these documents.

Проверка службы извлечения
After you have confirmed that the documents you want to extract content from are standard forms, you
can then plan the type of standard forms extraction service that fits your requirement.
The following technologies are available for processing standard forms:

IQ Bot extraction service

This is a template based extraction service that uses Распознавание текста (OCR) and heuristics to
extract content from standard forms. You have to train one template per standard form.
Guidelines for using IQ Bot extraction service
• Documents are of good quality (300 dpi)
• Document content is not very dense
• Input documents do not have any handwritten copies (limited support)
• Signatures are currently not supported
• Contains simple table layout (span within a page) with clear header, table boundaries, and so on
• Does not contain any tables or content that have checkboxes (limited support)
• Does not have any repeated sections (limited support)

Benefits of IQ Bot extraction service
• An integrated and simple out-of-the-box setup
• Various Распознавание текста (OCR) engines to increase accuracy of extraction
• Complex layouts (repeated sections, continuous tables etc) can be extracted for specific cases (needs

testing)
• Only requires IQ Bot license

Microsoft Azure Form Recognizer service

Third party technology, that provides custom built Artificial Intelligence (AI) models to extract content from
standard forms. You can create custom models where documents can be labelled and trained.

© 2023 Automation Anywhere. All rights reserved.     2557



    Automation Anywhere - Оцифровка

Guidelines for using Microsoft Azure Forms Recognizer service
• Input documents:

• can be dense (contain lot of details and information) and have a reasonable quality (>200 dpi)
• can contain checkboxes and radio buttons
• can have handwritten content
• can contain signatures
• can contain tables

The input documents can also contain tables that span over a single page. However, if the standard
forms contain table that span across multiple pages, the content extraction can fail.

• None of the sections in the input documents are not repeated
• Documents that contain transpose tables

Benefits of Microsoft Azure Forms Recognizer service
• Diverse standard form type documents can be processed
• Auto detection feature can identify different types of tables such as header-less table, inverted tables,

and so on
• Good support for handwritten forms

Проверка предварительных условий внедрения
After you have finalized the type of extraction service that suits your requirement, ensure that you review
the prerequisites before proceeding with the implementation of the service.

IQ Bot extraction service

Review the operating system and database compatibility, database information, and various hardware and
software requirements as part of prerequisites for using IQ Bot extraction service.
См. раздел IQ Bot system requirements on page 1077.

Microsoft Azure Form Recognizer service

Review the prerequisites of Microsoft Azure Form Recognizer service installation for standard forms.
• Cloud setup and installation

No additional configurations are required. However, based on the page processing volumes, the
Transactions Per Second (TPS) must be increased for the Microsoft region where your service is
running. Contact your Customer Success Manager (CSM) or Partner Enablement Manager (PEM) with
the expected page volume and Microsoft region where the service is running to update the TPS.

• On-Premises setup and installation
Pre-requisite for Azure Container on-prem installation for Standard Forms (A-People login required)

Considerations for optimum performance
Review the considerations to capture the performance metrics of IQ Bot standard forms with a new Model
containing more number of forms or table fields.
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Test summary

• Performance test was run for 10000 COVID Form documents (two pages per document = 20000 pages)
on a single node IQ Bot server using a single Bot Agent (using IQ Bot Extraction пакет). This test was
conducted to benchmark the performance metrics such as processing time, Straight Through Processing
(STP), validation, and documents processed (#successful processed pages/documents and #failed
pages/documents).

• New Model (WalgreenComplete 3260b299-68b5-4118-87df-b313bd5c30f6) with 26 Form Fields & 8
Tables fields are trained and used for extraction.

• With new Model (WalgreenComplete 3260b299-68b5-4118-87df-b313bd5c30f6), all the documents
were moving to validation during extraction. To get STP we marked below 5 fields as optional for this
test: A2PatientSign, B2Date, B2Sign, Phone, InsuranceCard(Table)->Card Details.

• Total time take to process 20000 pages using single Bot Agent was 25 hours, 21 minutes, & 42
seconds. This was based on IQ Bot On-Premises Build 12350.

• Average time take to process single page using IQ Bot Extraction пакет on single Bot Agent is
approximate 4.56 seconds.

• Achieved STP: 100% and Accuracy: 100%.
• During our test execution, the requests were served by Microsoft standard forms services hosted in us-

west2 region.
• As confirmed, Microsoft team TPS (Transactions Per Second) supported by us-west2 region was 100

TPS

Note:  KPI (Key Performance Indicators) like processing time, STP, accuracy might vary based on the
regions where Microsoft standard forms service is hosted and its transactions per second (TPS) rate.

Infrastructure configurations

The following table lists the infrastructure configurations:

Сервер Параметры Значения

Server 1 [Web Server] Control Room Windows Server 2019 → 8vCPU, 16 GB
RAM, 512 GB Disk [Rackspace Platform]-
uee

Server 2 [Database] База данных Windows Server 2019 → 8vCPU, 16 GB
RAM, 512 GB Disk [Rackspace Platform]

Server 3 [Application
Server]

IQ Bot Windows Server 2019 → 8vCPU, 16 GB
RAM, 512 GB Disk [Rackspace Platform]

Server 4 [Client] Bot Agent Windows Server 2019 → 4vCPU, 8 GB
RAM, 256 GB Disk [Rackspace Platform]

Product configurations

The following table lists the product configurations:

Параметры Значения

Automation Anywhere Enterprise Automation 360 Build 12313

Bot Agent 21.80.10273
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Параметры Значения

IQ Bot A360.24.28441-20220311

IQ Bot Extraction пакет 1.0.0-20220307-024320

База данных Microsoft SQL Server Developer (64-bit)

Протокол HTTPS

Network services Non-Active Directory

Data configurations

The following table lists the data configurations:

Параметры Значения

Домен Standard forms

Поставщик Forms Extractor Type 1

Модель WalgreenComplete 3260b299-68b5-4118-87df-b313bd5c30f6

Тип документа Multi page PDF document

Страницы Two pages per document

Form Fields 26
[A2Date, A2PatientSign, Address, Age, B2Date, B2Sign, City,
DOB, Email, FirstName, LTCFName, LastName, Phone, PrintName,
Race-American, Race-Asian, Race-Black, Race-Native, Race-
Other, Race-UnableToReport, Race-Unknown, Race-White,
RefusedInformation, State, VaccinationType, Zipcode]

Table Fields 8 tables, 23 table fields
Table1: DriversLicense[Issuance, LicenseNo]Table2:
Ethnicity[Hispanic, NotHispanic, UnableToReport,
Unknown]Table3: Gender[Female, Male]Table4:
InsuranceCard[Card Details, Medical Card, Pharmacy
Card]Table5: MedicareDetails[Medicare, Medicare
PartB]Table6: PatientCardHolder[DontKnow, No, Question,
Yes]Table7: PatientType[Resident, StaffMember]Table8:
ScreeningQuestions[DontKnow, No, Question, Yes]

Конфигурация COVID forms

# of Documents 10000

# of Pages 20000

Язык Английский

Test results

The following table lists the test results:
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Параметры Значения

Total Documents Uploaded 10000

Total Pages Uploaded 20000

Total Processed documents 10000

Total Processed pages 20000

Успешно 10000 documents

Pending Review (Validation) 0

STP 100%

Точность 100%

Processing Time 25 hours, 21 minutes, and 42 seconds

Resource consumption data

The following table provides the resource consumption data:

Параметры CPU Utilization in % Memory Utilization in %

IQ Bot Average: 3,4
Maximum: 26,8

Average: 70,9
Maximum: 78,9

Control Room Average: 1,4
Maximum: 14,5

Average: 83,3
Maximum: 84,8

База данных Average: 3,3
Maximum: 20,6

Average: 91,5
Maximum: 94,1

Bot Agent (Extraction) Average: 4,8
Maximum: 48,9

Average: 52,4
Maximum: 58,7

Настроить службу извлечения
To extract content from standard forms, you must setup and configure an extraction service. Review this
topic to understand how to setup each of the extraction service.

IQ Bot extraction service

No specific setup is required for content extraction through IQ Bot service. Ensure that you have access to
an active IQ Bot environment so that you can create a learning instance.
См. раздел Создать экземпляр для обучения on page 2504.
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Microsoft Azure Form Recognizer service

1. Subscribe to Microsoft Azure service
Microsoft provides the Azure Form Recognizer service. This service enables you to build automated
data processing software that can identify and extract specific content from documents. You must
have Microsoft Azure subscription in order to access Azure resources (OCR, Form Recognizer),
Automation Anywhere provides access to these resources through its subscription. Contact your
Customer Success Manager (CSM) or Partner Enablement Manager (PEM) who will help you setup the
services.
Request access for Microsoft Azure resources (OCR and Form Recognizer) (A-People login required)

2. Setup Microsoft Azure Form Recognizer service
a. For Cloud deployment

• If you have Automation Anywhere subscription, no additional configurations or changes are
required.

• If you have Microsoft Azure subscription, review the following article to setup and configure
your Microsoft Azure Form Recognizer for extracting content from standard forms.
Setup Azure Form Recognizer and Storage (Cloud) (A-People login required)

b. For On-Premises deployment
Setup Azure Form Recognizer and Storage (On-Premises) (A-People login required)

Configure IQ Bot for extraction service
IQ Bot must be connected to the extraction service for processing standard forms. The following section
provides details on how to configure IQ Bot for the selected extraction service. However, your IT Service
team can help you setup and configure the extraction service in IQ Bot.

IQ Bot extraction service

If you choose IQ Bot extraction service, no additional configurations are required.

Microsoft Azure Form Recognizer service

If you choose the Microsoft Azure Form Recognizer service, you must add Microsoft Form API and the
corresponding configurations in IQ Bot.
How to Setup and configure standard forms in IQ Bot (A-People login required)

Create the model in Document Automation

In Automation 360 v.26, you can configure the extraction model in the Control Room:
Create standard form in Document Automation on page 2618
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Создание модели извлечения
Data extraction model typically leverages Artificial Intelligence (AI) and Machine Learning (ML)
technologies to accurately extract text, key-value pairs, and tables from documents.

IQ Bot extraction service

Requires no separate AI model as this will be done as part of creating and training a learning instance in
IQ Bot.
См. раздел Создать экземпляр для обучения on page 2504.

Microsoft Azure Form Recognizer service

During your use case evaluation, Microsoft Azure Form Recognizer models can be created by Sales
Engineering. But for any production deployment, contact Professional Services, or Partner Enablement
Manager (PEM) at Automation Anywhere.
How to Create and train Azure Form Recognizer model (A-People login required)

The benchmarks for the time taken for labeling fields in the Microsoft Azure Form Recognizer service are as
follows:
• Up to 30 fields: 1 час
• 30 to 100 fields: 2 часов
• 100 to 400 fields: 4 часов

Note:  While creating a model, ensure there are no duplicate model names. And while creating a table,
ensure that the table name does not contain a space. For example, Sales chart.xls.

Transfer third-party extraction service models
Third party extraction models can be transferred from one subscription to another. Contact your
Automation Anywhere Customer Success Manager (CSM) for assistance.

IQ Bot extraction service

If you are using IQ Bot extraction service, no changes required.

Microsoft Azure Form Recognizer service

• Transfer models from one On-Premises to another On-Premises environment.
Transfer models from one environment to another (On-Prem) (A-People login required)

• Transfer models from one Cloud to another Cloud environment.
Transfer models from one environment to another (Cloud) (A-People login required)
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Note:  You can transfer standard forms learning instance along with an associated model between your
IQ Bot instances using API configurations. Для получения дополнительной информации см. раздел
Transfer standard forms learning instance and associated model (A-People login required)

Create a learning instance for standard forms
Learning instance is used in IQ Bot to extract, train, validate content from standard forms. Use the
following instructions to create a learning instance for processing standard forms in IQ Bot

Using IQ Bot extraction service
Ensure that you have access to an active IQ Bot environment so that you can create a learning instance.
См. раздел Создать экземпляр для обучения on page 2504.

Using Microsoft Azure Form Recognizer service

1. From the Document type drop-down menu select Standard Forms.
2. In the Standard form settings tab, from the Provider name drop-down menu, select a provider

for processing the form.
3. From the Configuration type drop-down menu, select the supported configuration.

This enables you to connect to one of the provider services configured during installation.
4. From the Select Model drop-down menu, select a pre-trained model for the selected configuration.
5. Click Browse to upload a reference document.

For example, if you have selected the configuration type and model as invoice, you can upload an
invoice file that must be analyzed.

Note:  The reference document is only a representation of the document type you want to extract
data from.

6. From the Fields to extract tab, select the fields from where the values must be extracted.
The fields are displayed based on the selected Form set in the pre-trained model, and no additional
fields can be added.

7. Click Create instance and analyze.
The system analyzes and sorts the document into logical group.

Note:  Only one default group is created. The system-identified region (SIR) are not visible and
all the training related fields are greyed out. As the standard forms learning instance contains pre-
trained model, no additional training of the group is available. You can only add validation patterns
and custom logic.

After you have created a learning instance, you must add a group specific to standard forms.
8. On the Learning Instance details page, click Add group.
9. Create group label as <Standard Forms layout name>.

For example, if you have W-4 documents for the year 2021, enter W4_2021.
10. Щелкните Сохранить.
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11. Open the system generated group
12. Click Delete Bot.

System generated group is removed from the Learning instance details page

Edit a standard forms learning instance
As the learning instances created by using standard forms have pre-set configurations, you can edit only
the name and the description. Also, you cannot edit instances in the production environment without
moving them to staging.

Note:  If you want to change the model associated with a learning instance, you must create a new model
and follow these instructions:
1. Create another learning instance similar to the previous one.
2. Associate the new model with this learning instance.
3. Select all the fields you had selected in the previous learning instance.
4. Update the validation rules.
5. Move the learning instance to production and associate a бот with this learning instance.

1. On the My learning instances page, select the learning instance you want to edit.
You can also use the Search bar to locate the learning instance.

2. Click Edit.
3. Edit the name of the learning instance in the Instance name field.

The document classification options are not available as the standard forms use a pre-trained model
and configurations.

4. Optional: Use the Document Groups tab to review the groups associated with the learning instance.

Note:  The Add group button is not available as adding groups is not supported for a standard forms
learning instance.

5. Optional: Click the Summary tab to review the learning instance.
Standard Forms details such as Provider, Configuration, and Model are available under this tab.

6. Щелкните Сохранить.
Changes made to the learning instance are updated on staging.

Define validation rules for standard forms learning instance
To prevent wrong or invalid data extraction, you can edit the бот associated with any standard forms
learning instance and customize the validation rules.
You can only edit a бот on staging. So ensure that you move any бот that you want to edit to staging if it
is in production.
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Using IQ Bot extraction service

Use IQ Bot Designer to train a learning instance and extract content from sample documents. Review each
field to ensure the correct value is extracted and where necessary, map the correct field.
Подробнее см. в разделе Train a learning instance on page 2515.

Using Microsoft Azure Form Recognizer service

1. On the Bot page, select the бот you want to edit.
You can also use the Search bar to locate the бот.

2. Click the Edit Bot icon.
3. In the Field column, click Field options.
4. Enter any custom validation rules in the fields under the Validate Pattern tab.

Documents that are not processed are moved to the Validator, and fields with errors are flagged.
You can review the flagged fields in the Validator.
Use the IQ Bot Валидатор on page 2545

5. Enter post processing logic under the Logic tab, and click Save.
6. Щелкните Сохранить.

The updated бот is saved on staging and you can move it to production.

Upload documents for standard forms learning instance
Upload your documents to IQ Bot for an existing standard forms learning instance for content extraction.
For extracting content from a single document, use the Upload Document action from IQ Bot пакет in
Рабочая область RPA.
See.Upload document action on page 1678
For content extraction from multiple or large number of documents, you can use the Process documents
action from IQ Bot Extraction пакет in Control Room. Use the following instructions to upload multiple or
large number of documents:
1. Перетащите action Обработка документов в поток операций.
2. Click the Learning instance name drop-down menu and select a standard forms learning instance.
3. In the Desktop folder tab, enter the file path for the input folder or click Browse to select it.
4. Выберите выходную папку в поле Путь к выходной папке.
5. Установите флажок Отправить документы в валидатор IQ Bot на проверку.

Although the documents are processed using Bot Runner on your local machine, you must use this
option if you want to validate the documents in the Валидатор

6. Щелкните Сохранить.
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Download extracted content
After you have trained learning instance, use the Download all documents action from the IQ Bot пакет
to download extracted content from standard forms.
1. Drag the Download all documents action from the IQ Bot пакет.
2. Click the Learning instance name drop-down menu and select a standard forms learning instance.
3. In the Local output folder field, provide a path to your local folder where you want to extract the

content.
4. In the IQ Bot Document status, select the appropriate status for the documents:
5. Select Delete files from the server after downloading check box if you want to remove the files

from IQ Bot server.
6. В поле Сохранить ответ в переменную добавьте переменную.

A variable value in this field provides information if the download was successful or the reason for a
failure.

7. Click Save, and run the бот.
8. Перейдите в локальную папку вывода, чтобы просмотреть загруженные файлы.

The output folder can have up to three subfolders:
• Повторное обучение. Содержит документы, которые были отправлены на проверку.

Эти документы хранятся в исходном формате, и вы можете обучить их, загрузив в
существующий обучаемый экземпляр.

• Успешные. Standard form documents that have been processed successfully.
The output is a .json file. Tables in the input documents are auto extracted and saved as
separate .xls file with the table name.

• Проверить. Содержит документы, требующие проверки.
These documents will be available in the IQ Bot Валидатор and you can download the output
separately.

Note:  Depending on the content in the uploaded documents, you can also get the following
additional subfolders:
• Failed: Documents that failed the validation process.
• Необработанные. Documents that could not be classified.

Transfer standard forms learning instance
A standard forms learning instance is similar to the regular IQ Bot learning instance that describes the data
in a single document type, for example an invoice. It contains information such as the language used in
the documents and the fields to extract.
• Ensure that the source and destination systems are running the same IQ Bot version. Learning

instances from different IQ Bot versions cannot be imported because their database schema will not
match.

• Back up your database before importing learning instances.
• Export the .iqba file from the source IQ Bot environment.
• Import the .iqba file into the destination IQ Bot environment
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Related concepts
Manage learning instances on page 2542
A learning instance is an IQ Bot structure that describes the data in a single document type, for example
an invoice. It contains information such as the language used in the document and the fields to extract.

Export a standard forms learning instance
Standard forms learning instance can be used across similar IQ Bot environments. Export an existing
learning instance to avoid creating another one with the same configurations.
IQ Bot administrator can use the following instructions to edit a standard forms learning instance:
1. Щелкните Администрирование > Миграция.
2. Click Create Backup.

Backing up your existing learning instance enables you to save and restore the configuration if
required.

3. Select the learning instances that you want to back up and then click Backup.
4. Enter a name for the IQ Bot archive (IQBA) file.

The name of the archive file is appended with a time stamp to make it unique. You can download this
file and export it to the target environment.

5. Click Backup to begin the export process.
The exported data file with the .iqba extension is available in the BackupData folder in your IQ Bot
output directory.

Import a standard forms learning instance
Import an existing learning instance from a similar environment to avoid creating learning instances and
associated боты multiple times. Use the Automation 360 IQ Bot Migration Utility feature to import any
standard forms learning instances.
Ensure that you have migrated the associated configuration to the target server before importing a
learning instance.
When you export an .iqba file, only a single document associated with every available бот (Group)
training is exported.
1. Log in to IQ Bot as an administrator.
2. Щелкните Администрирование > Миграция.

A list of backed-up learning instances is displayed.
3. Click the Import icon under the Actions tab for the selected learning instance.
4. Select the import method, and click Accept.

The selected standard forms learning instance is imported and is displayed under in My learning
instances page.

Document Automation
Document Automation — это новое Cloud решение для интеллектуальной обработки документов,
которое бизнес-пользователи могут настроить для автоматического чтения и быстрой обработки
документов с использованием предварительно обученных моделей и обратной связи при валидации.
Решение Document Automation полностью интегрируется в Automation 360: Document
Automation устанавливается как часть Control Room, боты RPA используются для извлечения
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полуструктурированных данных с целью автоматизации бизнес-процессов, ориентированных на
работу с документами, и Automation Anywhere Robotic Interface управляет сквозным процессом
извлечения и задачами валидации.

Поток операций Document Automation позволяет пользователям масштабировать операции
обработки документов. Пользователи создают обучаемые экземпляры, которые используют
предварительно обученные модели Automation Anywhere или Google Document AI для обработки
счетов-фактур, счетов за коммунальные услуги и квитанций. После запуска обучаемого экземпляра
в производственной среде он автоматически повышает точность извлечения на основе обратной
связи, полученной в результате ручной валидации.
Чтобы сравнить функции Document Automation с Automation 360 IQ Bot, см. Intelligent Document
Processing solutions feature comparison matrix on page 2576.
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Настройка окружения Document Automation

Document Automation устанавливается одновременно с Control Room и совместно использует базу
данных Control Room. Дополнительные задачи по установке для пользователей Control Room Cloud
отсутствуют.
Чтобы приступить к использованию Document Automation, необходимо сначала настроить
пользователей, функции и устройства и подключить Control Room к Automation Anywhere Robotic
Interface:
Set up your Document Automation environment on page 2578

Note:  Для установки Document Automation на сервере On-Premises обратите внимание на
следующее.
• The Control Room stores Document Automation output data.
• You must install the Control Room in a configuration that points to the location where Document

Automation data is stored. Ensure there is sufficient storage space.
• The minimum necessary storage space depends on the processing volume, document size, and use

case. As a guide: an environment that processes 100,000 pages per month, with a 30-day data
lifespan, requires 500 GB of storage space.

Использование Document Automation

Workflow map: Click the following schematic image to view the  workflow in an interactive visual

format:
1.

Ниже приведен обзор процесса создания, конфигурации и публикации обучаемого экземпляра в
Document Automation:

Шаг 1. Создание обучаемого экземпляра Войдите в Control Room как пользователь,
создающий обучаемый экземпляр, и создайте
обучаемый экземпляр для извлечения значений
из документов.

Шаг 2. Обработка документов Загрузите документы в учебный экземпляр,
чтобы протестировать модель, исправьте ошибки
валидации и проверьте извлеченные данные.
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Шаг 3. Build a бот to upload documents to Document
Automation on page 2602

Создайте бот, который загружает документы из
исходной папки в Document Automation.

Шаг 4. Publish the learning instance on page 2601 Check-in the learning instance assets (process,
form, and боты) to the public repository. Then,
deploy the process and боты to unattended Bot
Runner devices to begin processing documents in
real time.
После развертывания процесса входящие
документы обрабатываются, и Document
Automation либо извлекает данные из
документов, либо отправляет документы на
валидацию.

Шаг 5. Проверка загруженных документов Войдите в систему как пользователь
«Валидатор», откройте очередь проверки и с
использованием Валидатор исправьте ошибки.

Related concepts
Document Automation пользователей on page 2580
With the required roles, permissions, and licenses, Document Automation users can perform various tasks.
Users and roles are defined in the Administration tab.
Related tasks
Set up your Document Automation environment on page 2578
Document Automation is installed simultaneously with the Control Room. Configure the users, roles, and
devices, and connect the Control Room with Automation Anywhere Robotic Interface.
Related reference
ЧАСТО ЗАДАВАЕМЫЕ ВОПРОСЫ ПО Document Automation on page 2574
Answers to frequently asked questions (FAQs) on the latest Automation Anywhere intelligent document
processing solution, Document Automation.
Related information
Document Automation Developer Training (A-People login required)

Document Automation architecture
Document Automation uses features from the Control Room and Automation Anywhere Robotic Interface,
as well as some third-party products.
The following architecture graphic demonstrates the flow of data in the intelligent document processing
workflow for the two possible deployment scenarios:
• The Learning instance creator uploads documents to the Document Automation interface, for example

to test the extraction capabilities of the learning instance.
• An Unattended Bot Runner deploys the Scheduler Bot to upload and process the documents.

The graphic also shows the scenarios where data is sent to third-party products, such as for Google
Document AI or Standard Forms extraction.
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Control Room to regions mapping

Document Automation is supported on AWS and Google Cloud Platform.
For customers who configured Document Automation with Google Document AI licenses
purchased from Google: Documents uploaded to Document Automation for processing in Google
Document AI are sent to the Apigee gateway that you configured when you created the processor in
Google Document AI.
For customers who purchased Google Document AI product licenses from Automation
Anywhere: Google Document AI uses the Apigee API gateway to manage the document processing APIs.
When a document uploaded to Document Automation is sent to Google Document AI, data is sent to the
Apigee gateway that corresponds with your AWS or Google Cloud Platform region.

Apigee gateway AWS/Google Cloud Platform regions

США • US-East
• US-Central
• US-West
• CAN
• LATAM

Europe • EU-West1
• ЕС (Запад 4)
• ME
• S-Africa
• AP-Aus
• AP-Singapore
• AP-JP
• Индия

Related concepts
Data extraction in Document Automation on page 2585
Understand how the system improves extraction accuracy though user-provided changes in the
Валидатор.
Сведения о Automation 360 on page 11
Платформа Automation Anywhere Digital Workforce — это основа безопасной и масштабируемой
автоматизации сложных бизнес-операций. Automation 360 — это ведущая в отрасли платформа RPA
и цифровых рабочих ресурсов, которая сочетает в себе простой в использовании пользовательский
интерфейс с надежностью корпоративного класса и безопасностью для самоавтоматизации в
режиме реального времени.
Related reference
About the AARI process in Document Automation on page 2589
Document Automation uses Automation Anywhere Robotic Interface technology to manage the end-to-end
document extraction process. When you create a learning instance in Document Automation, the system
also creates an AARI process. Review the following guide to understand the logic.
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ЧАСТО ЗАДАВАЕМЫЕ ВОПРОСЫ ПО Document Automation
Answers to frequently asked questions (FAQs) on the latest Automation Anywhere intelligent document
processing solution, Document Automation.

Product FAQ

What pre-trained models are included? Automation Anywhere offers invoices and Google
Document AI offers invoices, utility bills, and
receipts.

Does Document Automation have feature
parity with Automation 360 IQ Bot?

Document Automation supports the following
features from Automation 360 IQ Bot:
• Data extraction from text, number, date time,

and check box fields
• Validation rules based on patterns, formulas,

lists, and statements

Which browsers are supported? Document Automation is supported on the same
browsers as the Automation Anywhere Control
Room: Google Chrome, Microsoft Internet Explorer,
and Microsoft Edge.

Note:  If you use Document Automation in Firefox,
the user interface might not behave as expected.

What languages are supported? Document Automation supports English, Dutch,
French, German, Italian, Portuguese (Brazilian), and
Spanish.

Note:  Extraction for French, German, and Spanish
language documents is currently in preview.
Extraction results will improve in future releases.

You can process documents in other languages by
creating and training a training a learning instance
in Automation 360 IQ Bot and connecting it with
Document Automation to process documents using
Document Automation technology and workflow.
Подробнее см. в разделе Подключить обучаемый
экземпляр on page 2599.

What file formats are supported? Document Automation can process documents in
the following file types:
• PDF
• JPG
• JPEG
• PNG
• TIF
• TIFF

© 2023 Automation Anywhere. All rights reserved.     2574



    Automation Anywhere - Оцифровка

Which licenses are necessary? The IQ Bot Pages product licenses is necessary
for processing documents. The Automation
Anywhere Robotic Interface license is necessary
for processing documents in learning instances in
production.
To send documents to Google Document AI
for extraction, you must also have the Doc AI
 Document product license.

Note:  To configure the Control Room with your
Google Document AI license key, you must do
these steps: Configure key for Google Document AI on
page 2581. These steps are not necessary if you
purchased Doc AI Document licenses through
Automation Anywhere.

We provide a recommendation on configuring
users with the minimum necessary roles and device
licenses to perform specific tasks in Document
Automation пользователей on page 2580.

Can learning instances be migrated from
Automation 360 IQ Bot to Document
Automation?

Users can connect their learning instances
from Automation 360 IQ Bot to their Document
Automation environment, which allows them to
process documents using the Document Automation
technology without having to rebuild the learning
instances. Подробнее см. в разделе Подключить
обучаемый экземпляр on page 2599.

Are customers required to maintain their
Automation 360 IQ Bot environments?

If you have connected a learning instance
from Automation 360 IQ Bot to Document
Automation, do not delete the learning instance
from Automation 360 IQ Bot since it stores the
training data.
We recommend you maintain Automation 360 IQ
Bot in a version compatible with the associated
Control Room.

What learning instance fields are supported
out of the box?

Document Automation offers over 35 of the most
common invoice fields, with the option to configure
custom fields. To see all the possible fields when
you are creating a learning instance, click Show
unused fields.

Processing and extraction FAQ

Which OCRs are supported? The Automation Anywhere pre-trained model uses
the ABBYY FineReader Engineor the Google Vision
OCR.

I uploaded documents for processing, but
nothing is happening.

The first time you process documents, the
Document Extraction пакет downloads to the local
device. This might cause a delay in document
processing.
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What should I do if a folder contains
documents in multiple languages?

Use the IQ Bot Classifier пакет to sort the
documents by language, then create a learning
instance for each language.

How do I process documents using Google
Document AI?

Document Extraction enables users to send their
documents to Google Document AI for processing.
To use this feature, users must have Document
AI licenses that they either purchased from
Automation Anywhere or provided their Google
Document AI account credentials to the Control
Room.
The process of creating, testing, and publishing
is the same for learning instances using a Google
Document AI model as for learning instances using
a pre-trained model from Automation Anywhere.

Are multi-page tables supported? Yes, Document Extraction supports extracting tables
that span across multiple pages.

Is it possible to extract multiple tables from a
document?

At this time, Document Automation can extract one
table per document.

Where can I see the reason why data was not
extracted from an uploaded document?

The AARI Requests tab holds the history for each
uploaded document. Here, you can see the step at
which extraction failed or if a Validator user marked
the document as invalid.

Is currency extraction supported? Yes, except for the rupee (₹).

Intelligent Document Processing solutions feature comparison
matrix
Review the differences between Automation 360 IQ Bot and Document Automation by comparing the
features in them.

Automation 360 IQ Bot Document Automation

Администрирование и настройка

Установка Отдельный установщик Устанавливается в составе
Control Room

Администрирование баз
данных

Отдельная база данных;
требует дополнительных
действий для резервного
копирования и обслуживания

Использует базу данных
Control Room; не требуется
дополнительного
резервного копирования или
обслуживания

Конфигурация сервера Requires additional SSL
configuration, RabbitMQ
administration, HA and DR

Готово к работе

Конфигурация обучаемого экземпляра

Управление псевдонимами
(ключевые слова)

No way to add or remove field
aliases for domains, only for
document groups

Users can view, add, or remove
field aliases for the learning
instance
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Automation 360 IQ Bot Document Automation

Порог достоверности Does not work out of the box;
server-level configuration

Helps to catch false positive
outcomes; field-level
configuration

Настройка порядка
следования полей и их имен

Not supported Помогает повысить
эффективность проверки

Конфигурация поля Must be done for every group Needs to be done only one time
for a learning instance

Ability to add and remove fields
from the learning instance

Нет Да

Extraction capabilities

Предварительно обученные
модели

Domains required training Can process invoices, receipts,
and utility bills

Обработка вариантов
документов

Classifier relies on document
layout and training. Documents
uploaded with a new layout are
sent to a new document group,
which requires training. Some
docs could not be classified.

Layouts are identified using
an object detection model to
find key-value pairs. It is not
necessary to configure all the
fields in a learning instance
before uploading documents.

Процесс обучения Each group needs to be
manually trained before it can
process documents

Learning instance extraction
improves based on changes
users make in the Validator

Output format CSV only CSV or JSON

Проверка и валидация с участием человека

Validation queue management Нет Use filters and search to find
specific learning instances or
documents

End-to-end automation

Task боты Должно быть создано вручную Control Room automatically
creates task боты for a learning
instance

See status and history of
uploaded documents

Нет Да

Customizable document
processing workflow

Нет Да

Безопасность

Политика хранения Нет Поддержка хранилища AARI
See Cloud storage retention policy

Управление секретами Нет Can use credential vault to store
Google Document AI credentials
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Set up your Document Automation environment
Document Automation is installed simultaneously with the Control Room. Configure the users, roles, and
devices, and connect the Control Room with Automation Anywhere Robotic Interface.

1. Log in to Document Automation through the Control Room.
You will receive an email from Automation Anywhere with your URL and credentials. Open the Control
Room URL in your browser, enter your credentials in the login screen, and click Log in.

2. Upload the Document Extraction пакет to the Control Room: Upload the IQ Bot packages to the Control
Room

3. Create a custom role that allows users to check in and check out боты, manage пакеты, and validate
documents.: Create a custom role for Document Automation on page 2579

4. Create the users necessary to complete the end-to-end process of creating and publishing a learning
instance: Document Automation пользователей on page 2580

Note:  When creating the Unattended Bot Runner user, provide the device credentials. You will
connect the Unattended Bot Runner to the device in the next step.

5. Configure the unattended Bot Runner user device and device pool to allow the learning instance to
function in public mode:
a) Using Remote Desktop Protocol (RDP), open the virtual machine where the unattended Bot

Runner will run.
b) Log in to the Control Room as the Document Automation Admin user you created previously.
c) Перейдите в раздел Управление > Устройства и щелкните Подключить локальное

устройство. Выполните инструкции мастера, чтобы подключить Control Room к своему
устройству.

d) Щелкните Обновить, чтобы проверить подключение устройства.
e) Click Create device pool and perform the following steps:

1. Enter a name for the device pool.
2. Click Devices and then the arrow to move the device to the Selected column.
3. Click Consumers and then the arrow to move aari-document-processor to the

Selected column.
4. Click Create device pool.

You can perform the following steps in the virtual machine or you can return to your device. If you
perform the following steps on your device, ensure that you log in to the Control Room as the Document
 Automation Admin user.
6. Open Automation Anywhere Robotic Interface to connect it with the Control Room.

a) Navigate to the AARI interface by adding /aari after your assigned Control Room URL.
b) Navigate to Manage > Process > Global scheduler and click Edit.
c) Select the Scheduler user that you created previously and click Save.

Отобразится указанное ниже сообщение. Secure connection between AARI Web and
 Enterprise Control Room established successfully
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7. Create a team in AARI to grant the Validator user access to the documents awaiting validation.
a) Navigate to Manage > Team > Create new team.
b) Enter a team name.
c) Select the Shared request visibility.
d) In the Users field, add the Validator user that you created previously and click Save.

If users will create learning instances that use the Google Document AI model and you did not
purchase Google Document AI licenses through Automation Anywhere, follow the steps to
Configure key for Google Document AI on page 2581.
Log in to the Control Room as the Learning instance creator user and begin creating learning
instances: Использование Document Automation on page 2570
Related tasks
Installing additional licenses on page 2810
Upload new licenses to the Automation Anywhere Control Room to be distributed to users as required.
Related reference
Лицензии Automation 360 on page 1017
На странице Все лицензии отображается подробная информация о текущих лицензиях продукта и
устройства.

Create a custom role for Document Automation
With a custom role, Document Automation users can check in and check out боты, manage пакеты, and
validate documents.

1. Navigate to Administration > Roles > Create role.
2. Provide a name for the role, such as aari-document-processor.
3. In the Feature permissions page, select the following:

• Просмотреть моих ботов
• Запустить моих ботов
• Экспортировать боты…
• Импортировать боты…
• Создать папки
• Переименовать папки
• Отменить извлечение

Пакеты
• Просмотреть пакеты
• Управлять пакетами

Automation Anywhere Robotic Interface
• Чтение между рабочими группами
• AARI Scheduler

4. In the Bots permissions page, select all the check boxes in the Bots row.
5. Click Save to create the role.
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Create users and assign this custom role to them. For more information about the required users, refer to
Document Automation пользователей on page 2580.

Document Automation пользователей
With the required roles, permissions, and licenses, Document Automation users can perform various tasks.
Users and roles are defined in the Administration tab.
The following table contains information about each type of user that interacts with Document Automation.
It includes a description of the tasks that each user performs, the required roles, permissions, and licenses,
and links to the pages most relevant to that user. Use this page to guide you in creating the users in the
table below: Create a user on page 2699

Note:  Some users require a custom role in Document Automation. This role grants users permissions to
check in and check out боты, manage пакеты, and validate documents. For instructions on how to create
a custom role, see Create a custom role for Document Automation on page 2579.

ПользовательОписание Функции Лицензия Related links

Learning
instance
creator

Can create, edit,
and delete learning
instances, upload
documents for
processing, and check
in or check out learning
instances.

AAE_Службы
IQ Bot,
AAE_Основы,
and aari-
document-
processor
custom role

Bot Creator Создание обучаемого
экземпляра в Document
Automation on page
2582

Обработка документов
в Document Automation
on page 2591
Publish the learning
instance on page 2601

Стандартные
формы
model
creator

Creates an extraction
model.

AAE_Службы
IQ Bot or
AAE_Администратор
IQ Bot

Document
Automation
Стандартные
формы (Number
of pages)

Create standard form in
Document Automation on
page 2618

Администратор
Document
Automation

Deploys the AARI
process and RPA боты
to the unattended Bot
Runner, manages AARI
teams, and assigns
validation tasks to a
team

AAE_Администрирование,
AAE_Администратор
групп,
AAE_Администратор
ячейки, and
AAE_Диспетчер
роботизированного
интерфейса

-- Set up your Document
Automation environment
on page 2578
Create an AARI team
and assign team roles to
members on page 2180
Publish the learning
instance on page 2601

ПланировщикEnables the Control
Room and AARI to
connect learning
instances in public
mode to AARI
processes.

Note:  This user is not
associated with a real
person.

AAE_Службы
IQ Bot,
AAE_Основы,
and aari-
document-
processor
custom role

-- --
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ПользовательОписание Функции Лицензия Related links

Bot
Runner
без
сопровождения

Runs the RPA боты for
learning instances in
public mode to upload,
process, and download
documents.

Note:  This user is not
associated with a real
person.

AAE_Службы
IQ Bot,
AAE_Основы,
and aari-
document-
processor
custom role

Note:  Provide
the device
credentials when
you configure
this user. You
will connect the
Unattended
 Bot Runner
user to the
device in one of
the steps in Set
up your Document
Automation
environment on
page 2578.

Unattended
Bot Runner,
Automation
Anywhere
Robotic
Interface, and
the product
licenses
necessary
to upload
documents
to learning
instances in
production:
IQ Bot pages,
standard forms,
or Document AI
Document
processing product
licenses

--

Валидатор Validates documents
that were processed by
a learning instance in
public mode.

AAE_Валидатор
IQ Bot and
AAE_Пользователь
роботизированного
интерфейса

Automation
Anywhere
Robotic Interface

Validate documents in
Document Automation on
page 2612

Related tasks
Create a user on page 2699
Create a user and assign their specific license based role.
Create a role on page 2708
As an administrator, you can configure roles with permissions to access features and perform operations
such as create, edit, or delete a бот in the Control Room, and assign the role to a user.
Related reference
Лицензии Automation 360 on page 1017
На странице Все лицензии отображается подробная информация о текущих лицензиях продукта и
устройства.

Configure key for Google Document AI
If the learning instance uses a Google Document AI model and you did not purchase Google
Document AI licenses through Automation Anywhere, follow these configuration steps.
• If you have not done so already, complete the steps to Set up your Document Automation environment on

page 2578.
• Log in as the Admin user type. For more information about the user types, refer to Document

Automation пользователей on page 2580.
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You will assign this role to a Credential Vault ячейка, which will allow the Learning instance
 creator user to securely provide the Google Document AI key to the Extraction bot, allowing the
learning instance to send documents to Google Document AI for extraction.
Create a custom role to access the Credential Vault ячейка that holds the Google Document AI key:
1. Navigate to Administration > Roles > Create role.
2. Provide a name for the role, such as doc-ai-credential-role.

The Manage my credentials and lockers permission is automatically selected.
3. Click Create role.
Assign the role to the Learning instance creator and Unattended Bot Runner user types.
4. Navigate to Administration > Users and locate the users.
5. For each user, click Edit user and add the doc-ai-credential-role.
Create a credential to store the Google Document AI key:
6. Navigate to Manage > Credentials > Create credential.
7. Provide a name for the credential, such as doc-ai-credential.
8. Provide a name for the attribute, such as ServiceAccount.
9. Select the Standard input option and enter the Google Document AI API key in the Value field.
10. Click Create credential.
Create a ячейка to store the key and provide access to other users.
11. Navigate to the Lockers tab and click Create locker.
12. Provide a name for the ячейка, such as doc-ai-locker.
13. Select the doc-ai-credential and click the right arrow to move the credential to the Selected

column.
14. In the Consumers tab and select the doc-ai-credential-role and click the right arrow to move

the credential to the Selected column.
15. Click Create locker.

Log in as the Learning instance creator user type to do the following:
• Create a learning instance: Создание обучаемого экземпляра в Document Automation on page 2582
• Provide the credential to the Extraction bot: Configure Extract action to process documents in Google

Document AI on page 1505

Related tasks
Installing additional licenses on page 2810
Upload new licenses to the Automation Anywhere Control Room to be distributed to users as required.
Related reference
Лицензии Automation 360 on page 1017
На странице Все лицензии отображается подробная информация о текущих лицензиях продукта и
устройства.

Создание обучаемого экземпляра в Document Automation
Begin processing documents by creating a learning instance to extract data from invoices, utility bills,
or receipts. Обучаемый экземпляр — это структура, содержащая такую информацию, как тип
документа, язык и поля для извлечения.
• To create a learning instance, you must be a Learning instance creator user. См. раздел

Document Automation пользователей on page 2580.
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• To create a learning instance that uses a Google Document AI model, you must create a credential and
locker to hold your security token. См. Создать учетные данные on page 2858 и Создать ячейка on
page 2859.

Note:  When configuring the ячейка, you must add the aari-document-processor custom role as
a ячейка consumer.

• The default OCR is ABBYY FineReader Engine. Alternatively, Cloud Control Room users can create a
learning instance to process documents in Google Vision OCR.

Watch this video for the complete end-to-end process of creating a learning instance:
1. From the Control Room home page, navigate to Manage > Learning Instances > Create

Learning Instance.
2. Enter a name and description for the learning instance.

Document Automation does not allow duplicate learning instance names, so the name you provide
must be unique.

3. Select the document type: Invoice ,User-defined, Utility Bill, or Receipt
Use the user-defined document type to process documents that are visually similar to invoices, such
as purchase orders and sales orders, which contain key-value pairs and a table structure. In this
document type, you create and configure all of the form and table fields.

4. Select the language.
Document Automation supports English, Dutch, French, German, Italian, Portuguese (Brazilian), and
Spanish.

Note:  Extraction for French, German, and Spanish language documents is currently in preview.
Extraction results will improve in future releases.

5. If you selected Invoice: Select the provider.
If you selected the English language in step 4, Automation Anywhere (Pre-trained) is auto-
selected.

6. For learning instances with the Automation Anywhere (Pre-trained) provider, you can opt in
to send feedback to the system to improve extraction results. Для получения дополнительной
информации см. раздел Improving extraction accuracy through validation on page 2586

7. Optional: Select the OCR provider. By default, Document Automation processes documents in ABBYY
FineReader Engine.
Users with a Cloud Control Room can select to process documents in Google Vision OCR.

8. Щелкните Вперед.
We recommend that you open a sample document side by side with the Control Room window as you
configure the form and table fields.

Note:
• A form field is a type of field that occurs only once in a document.
• A table field is a type of field that reoccurs throughout a document, typically in the form of a table.

9. Configure the form and table fields for extraction.
Document Automation offers a standard set of form and table fields, many of which are not initially
visible. You can search for a field by field name, field label, or data type.
To see the full list of fields, click Show unused fields. See the following video for a demonstration:
Click a field to open the fields editor. You can edit most attributes of a field. You cannot edit the name
and default aliases. Document Automation assigns default aliases, which are hardcoded keywords, to

© 2023 Automation Anywhere. All rights reserved.     2583



    Automation Anywhere - Оцифровка

standard fields to help with extraction. You cannot modify or delete default aliases, but you can add
aliases in the Custom aliases field. See the following video for a demonstration of creating a custom
alias:

Note:  Custom fields are not available for learning instances that use the Google Document AI
provider.

Mouse over the menu icon to the right of a field to access the up/down arrows. Use the arrows to
rearrange the order of the fields for a more efficient manual validation. The order of the fields does
not impact extraction.
To learn more about the other field attributes, review the table in the next step.

10. To add a field, click Add a field and complete the following fields:
Вариант Описание

Имя поля Enter a field name that begins with an alphabetical character (A-Z or a-z).
In standard fields, the field name is hardcoded and cannot be changed.

Метка поля Enter a user-friendly name to help validators.
For example, you can rename Organization tax number to a localized
name, such as VAT number.
The field label does not affect extraction.

Достоверность Set a threshold to reduce potential false positives.
At the time of processing, the Document Automation engine assigns a score to
each field in a document to indicate the certainty that the data was correctly
extracted. If the document contains fields with a score that is lower than the
confidence threshold, the document is sent to the validation queue.
If you enter a high confidence threshold, more documents will be sent to the
validation queue. If you enter a low confidence threshold, fewer documents will
be sent to the validation queue.
Supports values from zero to 100.

Тип данных Choose from Address*, Text, Number, and Date.
If the data in the field does not match the data type, the document is sent to
the validation queue.
Document Automation supports date and number format variations.
* If you are configuring a learning instance with a user-defined document type,
the form fields include the address data type, which extracts the entire structure
of an address.

Требуется Select one of the following:
• Required: Field cannot be empty.
• Необязательно. Field can be empty or not exist in the document.

Default aliases No action is necessary for this field. Document Automation assigns default
aliases, which are hardcoded keywords, to standard fields to help with
extraction.
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Вариант Описание

Пользовательские
псевдонимы

Additional keywords to help Document Automation locate the field. For example,
add country or region-specific names for fields such as VAT number as an alias
to an Organization tax number custom field.

Note:  Custom aliases must be unique. They cannot duplicate the default alias
of another field. Exception: Form fields can have duplicate custom aliases as
the table fields and vice versa.

Правила
проверки

Depending on data type, create rules using patterns, formulas, lists, and
statements such as starts or ends with.
Formula validation on page 2595 | Pattern validation on page 2598

11. Click Create.

When a new learning instance is created, the Control Room creates a folder with the
same name as the learning instance in the Automation > Document Workspace
folder. The folder contains two боты (extraction and download), a process, and a

form.
• Process: Manages the process using if/else scenarios through which Document Automation extracts

data from uploaded documents, assigns documents to users for validation, and downloads the
extracted data. To learn more, see About the AARI process in Document Automation on page 2589

• Extraction bot: Extracts data from defined fields in the uploaded documents.
• Download bot: Downloads the extracted data to a specific folder on the device or shared network.
• Form: Defines the input parameters that are sent to the process. Input parameters include the learning

instance name, uploaded file, and output file path.

Загрузите документы в обучаемый экземпляр, исправьте ошибки валидации и проверьте
извлеченные данные: Обработка документов в Document Automation on page 2591

Data extraction in Document Automation
Understand how the system improves extraction accuracy though user-provided changes in the
Валидатор.
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Improving extraction accuracy through validation

When a learning instance is created, the user has the option to enable this feature to send feedback to the
learning instance based on user-provided changes in the Валидатор. In Document Automation, learning
instances running in production mode can continuously "learn" whenever a user resizes or relocates the
extraction region in the Валидатор.

Note:  This feature is available only for Automation Anywhere pre-trained models.

The following graphic provides a visual overview of the process by which learning instances continuously
receive feedback from validation:
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1. An uploaded document passes through the extraction engine.
2. If the learning instance successfully extracts the data, the document is added to the straight-through

processing (STP) count and the extracted values are downloaded to a file in the Success folder.
If the learning instance can not extract the data, the system evaluates whether the document contains
an unfamiliar layout.

3. If the learning instance does not recognize the document layout (new layout), the document is sent
for manual validation where the user "teaches" the learning instance how to extract the data by
setting the extraction region.
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4. The extracted values are downloaded to a file in the Success folder and the changes are collected in
a feedback file, which is sent to the feedback database.

Note:
• Feedback is only collected when the user changes the extraction region. If the user manually inputs

text, the system does not collect feedback.
• The feedback file only contains data on the field location to improve extraction accuracy for

subsequent documents.

If the learning instance recognizes the cluster, it retrieves previous feedback from the feedback
database and uses it to extract data.

Using validation feedback to extract specific values in a table

As of Automation 360v.27, you can train a learning instance to extract data from a cell that contains more
than one field.
For example, if a product description column also includes item number, you can outline the item number
in the Validation interface. When the learning instance processes subsequent documents, it will extract the
item number and ignore the product description.
Follow this process to configure a learning instance to extract specific values from a cell:
1. Create a learning instance using an Automation Anywhere pretrained model and select the option to

send validation feedback: Создание обучаемого экземпляра в Document Automation on page 2582
2. Upload a sample document: Обработка документов в Document Automation on page 2591
3. In the Validator, locate the field and redraw the box to only surround the values that you want to

extract.
4. After you click Submit, the information on the new extraction region is sent to the feedback

database.
5. Upload more documents to test the accuracy of extraction. When you are satisfied with the results,

proceed to preparing the learning instance to run in production: Publish the learning instance on page
2601

How Document Automation identifies new layouts

Document Automation extraction is based on object detection. During document processing, the extraction
engine identifies objects, or key-value pairs of the field and associated value. The engine creates a
"fingerprint" of the document, which stores the sequence of the objects and each object's location in the
document.
When a document is processed, if the engine recognizes the keys and their locations, the document is
classified and extracted based on that existing fingerprint. Otherwise, the engine saves a new fingerprint of
the keys and their locations.
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About the AARI process in Document Automation
Document Automation uses Automation Anywhere Robotic Interface technology to manage the end-to-end
document extraction process. When you create a learning instance in Document Automation, the system
also creates an AARI process. Review the following guide to understand the logic.
When a learning instance is in production, each incoming document creates a new request, which triggers
the extraction process. If a document requires manual validation, AARI creates a validation task and
assigns it to a validation team.
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After the documents are processed, the Download bot downloads the extracted data to a file in the
Success folder.
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1. Start: The AARI form that defines the inputs, such as the learning instance name, uploaded
documents, and output folder.

2. Bot Task ExtractionBot: Executes the RPA bot that processes input documents to extract data from
them.

3. Document Validator Task: Opens the Validation user interface where the user can manually
validate the fields in the document.

4. Documents require validation: The ExtractionBot tried to process the documents then sent
the documents for validation, the documents were successfully validated, and the DownloadBot
downloaded the extracted data to the Success subfolder.
Request status = VALIDATION_SUCCESS

5. Invalid documents: The previous process was interrupted at validation, where a user marked
certain documents as invalid. These documents were downloaded to the Invalid subfolder.
Request status = VALIDATION_INVALID

6. Reprocessed documents: The previous process was interrupted at validation because the user
clicked Reprocess. Documents were sent back to the ExtractionBot for reprocessing.
Request status = VALIDATION_REPROCESSING

7. Documents are successfully processed: The ExtractionBot successfully processed the documents,
no documents required validation, and the DownloadBot downloaded the exacted data.
Request status = success and STP

8. Processing failed: The ExtractionBot failed to process the documents (for example: invalid format or
could not read the file) and the file is saved to the Failed subfolder
Request status = FAILED

9. Deployment failed: The Control Room failed to deploy the ExtractionBot (for example: lost server
connection). The Control Room makes three attempts.

Important:  We do not recommend deleting the process. If you unintentionally delete a process
associated with a learning instance, do the following steps to recover the process:
1. Navigate to Manage > Learning Instances and mouse over the actions menu to the right of the

learning instance.
2. Click Export.
3. Mouse over the actions menu to the right of the learning instance and click Delete.
4. Click Import at the top of the page.
5. Click Browse and select the .dw file you exported.
6. When prompted, click Overwrite to generate a new process for the learning instance.

Обработка документов в Document Automation
Upload sample invoices to test the learning instance, verify the extracted data, and fix validation errors.
• If you have not done so already, Создание обучаемого экземпляра в Document Automation on page

2582.
• Verify that your device is connected to the Control Room: Установка Bot Agent и регистрация

устройств on page 1046
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• If the learning instance uses a Google Document AI model and you did not purchase Google
Document AI licenses through Automation Anywhere, you must provide your Google Document
AI credentials to the Extraction bot. See Configure key for Google Document AI on page 2581

• If the learning instance uses an Automation Anywhere model, ensure that each file is 50 MB or less.
If the learning instance uses a Google Document AI model, ensure that each file is 20 MB or less, with
a maximum of 5 pages.

• Ensure that the sample documents are in one of the following supported document types:
• PDF
• JPG
• JPEG
• PNG
• TIF
• TIFF

• The default output format for the extracted data is CSV file. To change the output to JSON, see Change
output format from CSV to JSON on page 2595.
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Perform the following steps to upload sample invoices to the learning instance to test the data extraction
capabilities of the learning instance.
1. Upload documents to test the learning instance:

See these steps in a video:

a) Щелкните Обработка документов.

b) В окне Документы процесса щелкните Обзор, чтобы выбрать файлы для загрузки.
c) In the Download data to field, enter the file path that will hold extracted data.

When the process runs, it creates the following three folders in the provided file path:
• Success: Contains the extracted data in the specified format (CSV or JSON).
• Invalid: Holds documents marked invalid.
• Failed: Holds documents that could not be processed.

You can provide an output folder path based on one of the following options:
• Вариант 1. The local device path if you have set up document processing and validation on

the same device.
This option is typically used when you are testing the learning instance.

• Вариант 2. The shared folder path if you have set up distributed validation on separate
devices.
This option is typically used for published learning instances. For example, \
\10.239.192.60\Sharepath\Output.

d) Щелкните Обработка документов.
The Bot Runner window appears. The window disappears when the documents are done
processing. Refresh the Learning instances table to see the updated metrics.

If there is a value next to the Validate documents link, you must manually validate the document fields.
Otherwise, proceed to step 3.
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2. Fix the validation errors
a) Click Validate documents.

The AARI Task Manager opens in a new tab, with the first failed document in queue. For an
introduction to the Validator user interface, see Using the AARI Task Manager Validator for Document
Automation on page 2608.

b) Review each field to verify the data type and extracted value.
Document Automation supports the following data types: text, number, time, and check box
Alternatively, from the drop-down list on the right panel, you can select Show fields that need
validation.

Note:  When documents are awaiting validation, if you edit the learning instance, click
Reprocess to reattempt extraction.
Reprocessing documents does not affect the uploaded documents metric.

c) Update the fields with errors.
Click the field or draw a box around the values that you want to extract.
For Automation Anywhere pre-trained models, you can configure the learning instance to extract
specific values in a field and ignore others. Подробнее см. в разделе Using validation feedback to
extract specific values in a table on page 2588.

• To skip a document without correcting errors, click Skip to proceed to the next document in
the validation queue.

• To remove a document that cannot be processed, click Mark as Invalid.

d) After you make the necessary corrections, click Submit so that the document can finish
processing.
The next document in queue appears. When all the documents are corrected, the system displays
a message stating that no more tasks are available.

e) Close the tab to return to the Learning Instances page.

3. Verify the output results:
a) Open the file in the Success folder that contains the extracted data and review the results to

ensure that it matches your use case.
b) Optional: Review the Learning Instance dashboard.

The dashboard displays the total number of uploaded documents and the number of documents
pending validation.

If the learning instance repeatedly cannot find a field or if characters are not correctly recognized (such as
the letter "l" extracted as the number "1"), you can try changing the OCR to Google Vision OCR.
Build a бот that uploads documents from a source folder to the learning instance. Then, publish the
learning instance assets (process, form, and боты) to the public repository so that the learning instance
can be used in public mode to extract data from real documents, and validators can manually validate
documents: Publish the learning instance on page 2601
Related concepts
Извлечение данных из флажков on page 2601
Document Automation supports check box extraction for connected learning instances. Выходные данные
зависят от выбранного формата данных.
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Change output format from CSV to JSON
Data from successfully processed documents is available as a CSV file, by default. Change the output
format by editing the download data action before you begin uploading documents.
If you have not done so already, Создание обучаемого экземпляра в Document Automation on page 2582.
To change the output format to JSON, perform the following steps:
1. Navigate to Automation > Private tab > Document Workspace and click the folder with the

same name as the learning instance to configure the assets.
2. Open the process.
You must update the output format for DownloadBot-ValidationSuccess and DownloadBot-
Success:
3. Click DownloadBot-ValidationSuccess and locate the DocumentType field.
4. Change OUTPUT_CSV to OUTPUT_JSON.
5. Repeat steps 3 and 4 to change the output format for DownloadBot-Success.
6. Щелкните Сохранить.

Upload documents to the learning instance: Обработка документов в Document Automation on page 2591

Formula validation
Use basic arithmetic, comparative, logical, and functional operations.

Tip:  We recommended using functional operators instead of mathematical operators when validating
fields and tables for better accuracy.

When formulating an expression remember the following:
• All function names must be in capital letters.
• All formulas must result in either a true or false validation.
• Field and column names are case sensitive when used within formulas. If field is defined as Qty in

design, using qty or QTY in formula results in an invalid formula.
• For variable declaration or manipulation, ensure not to use certain keywords that are reserved for

formulating an expression, including SUM, SUB, DIV, MUL, COLSUM, IF.

Mathematical Operators

Operations Description Syntax

+ Addition Field/Column_Name1 + Field/
Column_Name2

- Subtraction Field/Column_Name1 - Field/
Column_Name2

* Multiplication Field/Column_Name1 * Field/
Column_Name2

/ Деление Field/Column_Name1 / Field/
Column_Name2
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Comparative Operators

Operations Description Syntax

== Equal To [Current Field/Column Name]
== [expression comprised of
one or more field/column name
or fixed numeric values]
For example, AMOUNT ==
MUL(QUANTITY, UNIT_PRICE)

>= Greater than or Equal To [Current Field/Column Name]
>= [expression comprised of
one or more field/column name
or fixed numeric values]
For example,
TOTAL_BILL_AMOUNT >=
AMOUNT_PAID

<= Less than or Equal To [Current Field/Column Name]
<= [expression comprised of
one or more field/column name
or fixed numeric values]
For example, AMOUNT_PAID
<= TOTAL_BILL_AMOUNT

> Больше [Current Field/Column Name]
> [expression comprised of one
or more field/column name or
fixed numeric values]
For example, BILL_AMOUNT >
0

< Меньше [Current Field/Column Name]
> [expression comprised of one
or more field/column name or
fixed numeric values]
For example,
DISCOUNT_PERCENTAGE <
100

!= Not Equal To [Current Field/Column Name] !
= [expression comprised of one
or more field/column name or
fixed numeric values]
For example, DEBIT_AMOUNT !
= 0
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Logical Operators

Operations Description Syntax

&& And: Field/Column is valid if all
conditions are true

<Current Field/Column Name>
<operator 1> <expression
1> && <Current Field/
Column Name> <operator 2>
<expression 2>
For example,
DISCOUNT_PERCENTAGE >=
0 && DISCOUNT_PERCENTAGE
<=100

|| Or: Field/Column is valid if any
one of the given conditions is
true

<Current Field/Column Name>
<operator 1> <expression
1> || <Current Field/Column
Name> <operator 2>
<expression 2>
For example,
DISCOUNT_PERCENTAGE >= 0
|| DISCOUNT_PERCENTAGE ==
'Net'

! Not: Converts a true expression
to false and also the other way
round

!<expression>
For example, !(AGE < 18) ==>
valid when AGE is not less than
18

Functional Operators

Operations Description Syntax

СУММА Summation: gives result of
addition of one or more field/
column/fixed-number values

SUM(n1,n2,....,nN)
For example, SUM(SUB_TOTAL,
SERVICE_TAX,
EDUCATION_CESS) ==>
equivalent to SUB_TOTAL
plus SERVICE_TAX plus
EDUCATION_CESS

SUB Subtraction: gives result of
subtraction of one or more
field/column/fixed-number
values from the first specified
value

SUB(n1,n2,....,nN)
For example, SUB(SUB_TOTAL,
TOTAL_DISCOUNT,
ADJUSTMENTS) ==>
equivalent to SUB_TOTAL
minus TOTAL_DISCOUNT minus
ADJUSTMENTS
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Operations Description Syntax

MUL Multiplication: gives result of
multiplication of one or more
field/column/fixed-number
values

MUL(n1,n2,....,nN)
For example,
MUL(QTY_IN_BOX,
UNIT_PRICE, SHIPPED_BOXES)
==> equivalent to
QTY_IN_BOX multiply-with
UNIT_PRICE multiply-with
SHIPPED_BOXES

DIV Division: gives result of
division of one or more field/
column/fixed-number values
from the first specified value

DIV(n1,n2,....,nN)
For example, DIV(AMOUNT,
SHIPPED_BOXES, UNIT_PRICE)
==> equivalent to AMOUNT
divide-by SHIPPED_BOXES
divide-by UNIT_PRICE

COLSUM Sum of a given Column
in a table: gives result after
evaluating given expression for
each row of specified table and
adding them all together

COLSUM("<table-name>",
"<expression to evaluate for
each row of specified table-
name>")
For example, FINAL_TOTAL
== COLSUM("LINE_ITEMS",
"MUL(QTY, UNIT_PRICE)")
Say there are 3 rows for
table LINE_ITEMS, then
FINAL_TOTAL should be equal
to MUL(QTY1, UNIT_PRICE1)
+ MUL(QTY2, UNIT_PRICE2) +
MUL(QTY3, UNIT_PRICE3)
where, QTY1 is QTY value in
row 1, similarly UNIT_PRICE1
is UNIT_PRICE value in row
2, and so on for other rows as
well.

Pattern validation
A pattern defines an acceptable format for date, number, or text fields. Reference the tables below for
common examples:

Текст

Field Pattern Notes Description

Эл. почта ^([a-z0-9_
\.-]+)@([\da-z
\.-]+)\.([a-z\.]
{2,6})$

This regular expression
validates emails like
john@ado.com.

The Email field
supports regular
expressions.
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Field Pattern Notes Description

Номер телефона ^(\(?\+?[0-9]*
\)?)?[0-9_\-
 \(\)]*$

This regular expression
validates phone
numbers like (+64) 38
3235393.

The Phone Number
field supports regular
expressions.

Website ^([a-zA-
Z0-9]+(\.[a-zA-
Z0-9]+)+.*)$

This regular expression
validates websites like
www.domain.com.

The Website field
supports regular
expressions.

Number string ^[0-9]{1,45}$ This regular expression
validates a string with
numbers 0 - 9 and limit
length to 45.

The Number string
field supports regular
expressions.

Alpha-numeric ^[A-Za-z0-9_@./
#&amp;+-]*$

This regular
expression validates
a string containing
alphanumeric values
like INV-001.

The Alpha-numeric
field supports regular
expressions.

Число

Field Pattern Notes Description

Number string ^[0-9]{1,45}$ This regular expression
validates a string with
numbers 0 - 9 and limit
length to 45.

The Number string
field supports regular
expressions.

Подключить обучаемый экземпляр
Подключитесь к обучаемому экземпляру в Automation 360 IQ Bot для обработки документов в этом
обучаемом экземпляре с использованием потока операций Document Automation.
To perform this task, you must have one of the following roles:
• AAE_Администратор IQ Bot
• AAE_Службы IQ Bot
• Пользовательская функция с разрешением Подключение обучаемого экземпляра

Откройте окружения Document Automation и Automation 360 IQ Bot на одном и том же устройстве.
Когда вы подключаете обучаемый экземпляр, который создан в Automation 360 IQ Bot, система
создает активы обучаемого экземпляра (боты RPA, процесс AARI и форма), чтобы обучаемый
экземпляр мог начать обработку документов в Document Automation.

Note:
• This feature is available only for Document Automation customers. It is not available in Community

Edition.
• Окружение Automation 360 IQ Bot должно быть связано с Control Room, где выполнена установка

Document Automation. Кроме того, следует использовать версию Automation 360 IQ Bot,
совместимую с Control Room.
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• Можно подключить один обучаемый экземпляр за раз.

Подключенный обучаемый экземпляр может извлекать данные из флажков, если на вашем
устройстве установлен пакет Microsoft Visual C++ 2019 Redistributable Package: Извлечение данных из
флажков on page 2601
1. Login to the Control Room as the Admin user. Navigate to Manage > Learning Instances. Click

Connect learning instance.
This takes you to Connect Learning Instances from IQ Bot classic page which contains a list of
Automation 360 IQ Bot learning instances.

2. Выберите обучаемый экземпляр из версии Automation 360 IQ Bot
для подключения. Move it from left to right. Щелкните Подключить.

The newly-connected learning instance appears in the Learning instances table in private mode.

Note:  Значение в столбце «Поставщик» указывает, был ли обучаемый экземпляр подключен из
Automation 360 IQ Bot или создан в Document Automation.
• Для подключенного обучаемого экземпляра в столбце «Поставщик» указано значение

Обученный пользователем.
• Для обучаемого экземпляра, созданного в Document Automation, в столбце «Поставщик» указано

значение Automation Anywhere (предварительно обученный).

Note:  Вы должны обеспечивать поддержку сервера Automation 360 IQ Bot, поскольку на нем
хранятся данные конфигурации и обучения для подключенного обучаемого экземпляра.

• Подключенный обучаемый экземпляр можно редактировать только в Automation 360 IQ Bot.
Чтобы отредактировать обучаемый экземпляр после его подключения, щелкните его имя
в таблице «Обучаемые экземпляры», и вы будете перенаправлены на страницу открытия
обучаемого экземпляра в Automation 360 IQ Bot в новом окне.

• Чтобы загрузить документы для обработки, щелкните Обработка документов. Обработка
документов в Document Automation on page 2591
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Извлечение данных из флажков
Document Automation supports check box extraction for connected learning instances. Выходные данные
зависят от выбранного формата данных.
Флажок — это объект пользовательского интерфейса, который позволяет сделать двоичный выбор:
выбрать определенную функцию или оставить ее невыбранной. Document Automation поддерживает
извлечение данных из флажков или переключателей, отмечаемых галочкой, крестиком или
точкой. В дополнение к квадратным флажкам и круглым переключателям Document Automation
поддерживает треугольные и ромбовидные контуры.
Document Automation поддерживает извлечение групповых флажков из подключенных обучаемых
экземпляров. Для получения дополнительной информации о групповых флажках см. Извлечение
данных из групп флажков в Automation 360 IQ Bot.

Note:  Чтобы включить обнаружение флажков, необходимо установить пакет Microsoft Visual C+
+ 2019 Redistributable Package на Bot Runner устройстве, на котором обрабатываются документы.
Download Microsoft Visual C++ Redistributable

Как выводятся данные

Возможные выходные значения: Yes: , NoИли No Checkbox Found. Формат вывода зависит от
выбранного формата Change output format from CSV to JSON on page 2595.

Note:  Вне зависимости от языка документа выходные значения всегда отображаются на английском
языке.

Publish the learning instance
Check-in the process associated with the learning instance. Then, build a бот that uploads documents from
a source folder to the learning instance and check it in to the public repository. Finally, deploy the process
and боты to unattended Bot Runner devices to begin processing documents in real time.
For Bot Runner devices with a Windows 2012 server-based operating system:
1. Download and install the Windows Essential Media Pack from Microsoft.
2. Install the Media Foundation feature from the Windows Server Manager.

1. Publish the process.
a) Navigate to Automation > Private tab > Bots > Document Workspace processes and

select the folder with the same name as the learning instance.
b) Mouse over the vertical ellipses to the right of the process to open the actions menu and click

Check in process.
The Check in Process window opens with the боты and form auto-selected to also be checked
in.

c) In the Check in Process window, add your comment and click Check in.
The process appears in the same folder structure in the public workspace.

See these steps in a video:

2. Build the Extraction-Scheduler бот to automate uploading documents to the learning instance:
Build a бот to upload documents to Document Automation on page 2602
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3. Publish the Extraction-Scheduler бот.
a) Locate the Extraction-Scheduler бот in the private tab.
b) Mouse over the triple ellipses to the right of the бот to open the menu and click Check in Task

bot.
The Check in Task bot page opens with the бот auto-selected.

c) Add a comment and click Check in.

4. Login as the Document Automation Admin user to deploy the process and боты to unattended
Bot Runner devices: Deploy the learning instance assets on page 2607

Once the process and Extraction-Scheduler бот are deployed, documents in the specified folder are
uploaded to Document Automation, and Document Automation either extracts data from the documents or
sends the documents for validation.
Navigate to Activity > In progress to see the status of the running боты.

Build a бот to upload documents to Document Automation
Build a бот to upload documents to a specific learning instance for processing and extraction.
• Ensure you have the name of the destination learning instance.
• If you have an adequate amount of Bot Runner connected. For instructions on connecting a Bot

Runner, see step 5 of Set up your Document Automation environment on page 2578.

Note:  You need a dedicated Bot Runner for this бот and additional Bot Runner for the extraction
and download боты, depending on the average number of pages in the documents. Review the
explanation below for more guidance on how many Bot Runner are needed.

• Decide on the scheduling interval for deploying this бот with a maximum interval of every thirty
minutes.

• Determine the average number of pages in the documents awaiting upload.

This бот is necessary for end-to-end automation of the document extraction process. When deployed,
the бот checks if there are enough Bot Runner to handle the documents, by comparing the number of
files already uploaded against a calculated value. The calculation considers the number of Bot Runner,
scheduling interval, and average number of pages in the documents.

Note:  This step is important as it controls the number of documents being uploaded to ensure smooth
processing and avoid overloading the Bot Runner, which might cause a time-out error.

To determine the number of Bot Runner needed, consider the following:
• One Bot Runner can process a single-page document in one minute.
• One Bot Runner can process a two-page documents in two minutes.
• One Bot Runner can process 1440 single-page documents in one day.
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• Two Bot Runner can process two single-page documents in one minute.

Use this equation to determine how many Bot Runner are needed:

Number of Documents to Process per day * Average Number of Pages per
 document / 1440 = Number of Bot Runner

Note:  If the equation result is not an integer, you must round up to the next whole number to obtain an
adequate number of Bot Runner. For example, if the equation result is 4.2, you will need 5 Bot Runner.

As an example, if you want to process 10,000 documents each day with an average of one page per
document, you need seven Bot Runner:

10,000 documents * 1 page per document / 1440 = 7 Bot Runner

To build the бот, follow these steps:
1. Navigate to Automation > Private tab and click Create a bot.

Ensure you do not place the бот in the Document Workspace folder.
2. Provide a name for the бот, such as Extraction-Scheduler.
3. Create the following variables: Create a variable on page 2044

Variable name Описание Тип данных Значение

File_Count Increments with
each loop iteration
to count the number
of files uploaded for
processing.

Число 0

Extraction_DeviceCountNumber of Bot
Runner devices
connected to the
Control Room

Число Enter the number
of connected Bot
Runner devices

Scheduler_IntervalScheduling interval in
minutes

Число Enter the interval
for which you will
schedule this бот
to run when you
deploy it (minimum
2 min,maximum 30
min)

Average_Pages Average number of
pages per document

Enter the
approximate average
number of pages in
the documents

FilesInFolder Holds file name and
extension

Словарь --

SourcePath File path to the
folder containing
documents awaiting
upload to Document
Automation

Строка Enter the file path
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Variable name Описание Тип данных Значение

OutputPath File path to the
folder containing
the extracted data
and invalid or failed
documents

Строка Enter the file path
where you want the
extraction output

4. Insert a Loop action to iterate through all the documents in a specific file path.
a) Дважды щелкните или перетащите action Цикл.
b) Select the For each file in folder iterator.
c) Insert the SourcePath variable into the Folder path field.
d) Insert the FilesInFolder variable into the Assign file name and extension to this

variable field.

5. Insert an If action to compare the number of documents uploaded for processing to the number of
Bot Runner devices multiplied by a scheduling interval and divided by the average number of pages.

Note:  You must include this equation to limit the number of files uploaded for processing at one time
to ensure that the Bot Runner are able to process the documents.

a) Drag the If action into the Loop container.
b) Select the Number condition.
c) Insert the File_Count variable into the Source value field.
d) Select the Less than operator.
e) Enter the following into the Target value field: $Extraction_DeviceCount$*

$Scheduler_Interval$/$Average_Pages$

6. Insert If: Else and Loop: Break actions to end the loop if the condition is not met:
a) Drag the If: Else action beside the If action in the Loop container.
b) Drag the Loop: Break action into the If: Else container.

7. Insert an error handling mechanism to log any possible errors:
a) Drag the Error handler: Try action into the If container.
b) Drag the Error handler: Catch action beside the Error handler: Try action.
c) Drag a Delay action below the Error handler: Catch action.
d) Set a delay of 10 seconds.
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8. Configure actions to upload documents to the process associated with a specific learning instance.
a) Drag the AARI Web: Create a request action below the Error handler: Try action.
b) Mark the Set LearningInstanceName option and provide the name of the learning instance

where to send the documents.
c) Mark the Set InputFile option and enter $SourcePath$/$FilesInFolder{name}$.

$FilesInFolder{extension}$.
d) Mark the Set InputFileName option and enter $FilesInFolder{name}$.

$FilesInFolder{extension}$.
e) Mark the Set OutputFolder option and enter $OutputPath$.
f) Drag the Number: Increment action below the AARI Web: Create a request action.
g) Insert the File_Count variable into the Number and Assign output to variable fields.

The Number action increases the value of File_Count by one each time a file is uploaded to
the learning instance. As long as the value in File_Count is less than the total in the equation
you entered in step 5, the бот can run another loop iteration to upload another document to the
learning instance.

9. Make a copy of the uploaded file to a different location on your desktop to keep track of which
documents were successfully uploaded:
a) Drag the File: Copy Desktop file action below the Number: Increment action.
b) Enter $SourcePath$/$FilesInFolder{name}$.$FilesInFolder{extension}$ in the

Source file field.
c) Provide the folder path where to copy the files.

10. Remove documents after they are uploaded to Document Automation so they do not get re-uploaded
in the next iteration:
a) Drag the File: Delete action.
b) Enter $SourcePath$/$FilesInFolder{name}$.$FilesInFolder{extension}$ in the

File field.

11. Щелкните Сохранить.

The completed бот should resemble the one in the image below:
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Publish the process and бот. See step 3 of Publish the learning instance on page 2601
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Deploy the learning instance assets
Deploy the process and RPA боты to the unattended Bot Runner devices, and assign the learning instance
to a validation team. Here, you configure the learning instance assets to process documents in real time.
• The user who created the learning instance assets must check-in the process, form, and боты to the

public repository. If you have not done so already, complete steps 1 and 2 of Publish the learning instance
on page 2601.

• To deploy the learning instance assets, you must be an Admin user. См. раздел Document Automation
пользователей on page 2580.

1. Assign the a team of Validators to the process:.
a) Open AARI by appending /aari to the Control Room URL.
b) Navigate to Manage > Process and locate the process with the same name as the learning

instance.
c) Click the process to assign it to a team.
d) Navigate to the Request Creation section and select the by Bot option.
e) Navigate to the Teams tab and click the Add icon on the left side.
f) Select the team and click Add and save.
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2. Deploy the Extraction-Scheduler бот
See these steps in a video:
a) Return to the Control Room by removing /aari from the Control Room URL.
b) Navigate to Automation > Public tab and locate the Extraction-Scheduler бот.
c) Follow the steps to Планирование бот on page 2631.

• At the scheduling details section, select Run repeatedly.
• Select the Repeat every option to schedule the бот on a recurring basis.

When you provide the desired interval and frequency, ensure that the interval matches the
value in the Scheduler_Interval variable in the Extraction-Scheduler бот.

Note:  If you are scheduling the бот to run starting today, you must repeat the steps two
times to schedule the бот as follows:
• Schedule the бот with the desired start time for today, with an end time of 11:59pm on the

same day.
• Schedule the бот to start tomorrow at 12:00am, with an end time of 11:59 on a future

date.

Important:  If you do not follow this guidance, the бот will start running each day at the
time you provided in the Start time field, instead of being scheduled to run for 24 hours of
each day.

• When selecting a Bot Runner, deploy the Extraction-Scheduler бот to a different Bot
Runner than the one running the process.

Note:  A Bot Runner can run only one бот at a time. Ensure that you use separate Bot
Runner for the process and the Extraction-Scheduler бот, so that the Extraction-
Scheduler бот does not interfere with the Extraction and Download боты.

Once the process and Extraction-Scheduler бот are deployed, documents in the specified folder are
uploaded to Document Automation, and Document Automation either extracts data from the documents or
sends the documents for validation.
Navigate to Activity > In progress to see the status of the running боты.

Using the AARI Task Manager Validator for Document Automation
Document Automation uses Automation Anywhere Robotic Interface technology to manage the end-to-
end document extraction process. Each incoming document creates a new request, which triggers the
extraction process. If a document requires manual validation, AARI creates a validation task and assigns it
to a validation team.
When you click the Validate documents link in the Learning instances page, the AARI Task Manager
opens in a new tab, with the first failed document in queue.

Note:  An empty page with a notification message appears in the following scenarios:
• If you are not assigned to any validation teams, and thus do not have access to learning instances.
• If there are no files that require validation in the learning instances to which you have access.
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• If another user is working on the remaining file in the validation queue.
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1. You can toggle between the Table and
Detail views

Detail view: We recommend that you perform
validation tasks in the Detail view because this
view shows all the documents in the validation
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queue side by side with the document that you are
currently validating. Additionally, when you finish
validating a document, the next document in the
queue automatically opens.

Note:  You can search for specific documents
(tasks) in Detail view only.

Table view: Use the Table view see learning
instance history. When you open a document from
this view, the history for the learning instance that
is processing this document appears in a pane on
the left. Click the empty text field, then select the
blue-bounded box in the document that contains
the data to extract. After you select a box, the data
is highlighted in yellow and a green outline appears,
which you can resize or reposition to include all the
data that you want to extract.

2. Filter the documents in your queue The Validator opens with certain filters enabled by
default to show only the documents from a specific
learning instance that need validation.

3. Your documents queue The documents that match the parameters you
specified in the filters pane appear here.
You can switch between documents in the queue
without completing validation for the current
document.

4. Customize your view Use the icons in the taskbar to hide the blue-
bounded system identified regions, stack the
document pane above the fields pane, or change
the zoom levels.

5. Toggle between the fields views Use the drop-down list to select between Show
all fields to see all the document fields or Show
fields that need validation to only show the
fields that need your manual validation.

6. Fields awaiting validation are outlined in
red

In the example above, the table fields Item total
and Quantity require manual entry.

7. Add or delete a row To insert or delete a row, hover over the ellipses to
show the icons for adding or deleting table rows.

8. Skip to next file Skip a file without correcting the errors in the
current document.

9. Повторно обработать If the learning instance is edited while documents
are awaiting validation, you must Reprocess the
documents.

10. Mark document as invalid Removes the document from the validation queue
and saves a copy of the document to the Invalid
folder. Click here to mark a document as invalid,
then select from the following reasons:
• Fields missing
• Tables missing
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• Wrong values

For documents processed in a connected
learning instance:

The Валидатор shows the group number for the
document. If you are unsatisfied with the extraction
results, you can retrain the learning instance in
Automation 360 IQ Bot.

Validate documents in Document Automation
If a learning instance cannot extract data from a document (for example, blurry text, data does not match
data type, or data is missing for a required field), it sends that document to the validation queue, where
the Validator user manually provides the data.
The learning instance assets must be checked-in to the public repository.
The Validator is comprised of two panels with the document on the left side and the fields with extracted
data on the right side.
In a window that is 1280 pixels or more, the panels are positioned side-by-side. Otherwise, the panel
containing the fields and extracted data shifts below the panel containing the document, as demonstrated
in this video:

Note:  If a document contains tables with large number of rows or data fields (>1000), there might be a
delay in the initial validation and the corresponding response time.

1. Log in as the Validator user.
2. From the Control Room home page, navigate to Manage > Learning Instances.

The Learning instances table displays details for each instance. The value in the Validate
documents link indicates the number of documents awaiting manual validation.

3. Click Validate documents.
The AARI Task Manager opens in a new tab, with the first failed document in queue. For an
introduction to the Validator user interface, see Using the AARI Task Manager Validator for Document
Automation on page 2608.

4. Provide correct values to the fields that need validation.
See these steps in a video:

a) Select Show fields that need validation from the drop-down list in the right panel.
b) Click the field to extract.
c) In the document image, click the blue-bounded box containing the correct data or draw a box

around the data you want to extract.
• To skip a document without correcting its errors, click Skip to proceed to the next document

in the validation queue.
• To remove a document that cannot be processed, click Mark as Invalid.

5. After you make the necessary corrections, click Submit so the document can be processed and the
extracted data downloaded.
The extracted values are saved to a file in the Success folder. The Валидатор shows the next
document in queue. When all documents are corrected, the system displays a message stating that
there are no more tasks available.
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Export/Import learning instances
A user with the IQ Bot Admin role or with the View and manage migration permission can use the
Export and Import buttons to move learning instances between Document Automation environments.

Export a learning instance

When you export a learning instance, a .dw file is downloaded to your desktop with the learning instance
configurations, including the language, provider, and fields.
To export a learning instance, navigate to Manage > Learning Instances and mouse over the vertical
ellipses to the right of the learning instance you want to export. Then, click Export.

Note:  The process and боты associated with the learning instance are exported separately: Export an
AARI process on page 2168 | Экспортировать боты on page 2851

Import a learning instance

First, import the process and боты associated with the learning instance: Импорт процесса AARI on page
2165. If you do not import the process, Document Automation will create a new process when you import
the learning instance.

Note:  Verify that the destination environment has the necessary licenses. См. раздел Лицензии
Automation 360 on page 1017.

To import a learning instance:
1. Navigate to Manage > Learning Instances and click Import at the top of the page.
2. Click Browse to select the learning instance.

Note:  If there is already a learning instance in this environment with the same ID number, the
imported learning instance overwrites the existing one.

3. Select whether to pair the learning instance with an existing process or to create a new process.

Using Document Automation for Стандартные формы
Стандартные формы are fixed format type documents that have a defined template, with little or
no variation in the overall layout, and are typically official or legal forms, such as a W-4 (Employee
Withholding Certificate) form, income tax form, or a sale deed.

See the following video on how Microsoft Стандартные формы integrates with Document Automation and
its enhanced processing capabilities.

With enhanced accuracy, this feature enables you to extract data from densely structured forms including
those with handwritten input in more than 200 languages. For more information on the supported
languages for text and field extraction and detection, see Language support for Form Recognizer.
The following overview provides an end-to-end process you can use to create the Стандартные формы
data model, configure the learning instance, and publish the learning instance to process documents
autonomously, all within the Document Automation interface.
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Note:  Set up your Document Automation environment, which includes configuring users, roles, and
devices, and connecting the Control Room with the Automation Anywhere Robotic Interface: Set up your
Document Automation environment on page 2578.

1. Evaluate your use case for Стандартные формы.
Evaluate your use case on page 2614

2. Review extraction service.

Проверка службы извлечения
3. Set up and configure an extraction service.

Настроить службу извлечения on page 2617
4. Configure Document Automation for the selected extraction service.

Configure Document Automation with Microsoft Azure Form Recognizer on page 2617
5. Build a data extraction model.

Create standard form in Document Automation on page 2618
6. Create a learning instance with the Стандартные формы data model.

Create a learning instance for standard forms on page 2620
7. Загрузите документы в учебный экземпляр, чтобы протестировать модель, исправьте ошибки

валидации и проверьте извлеченные данные.

Обработка документов
8. Создайте бот, который загружает документы из исходной папки в Document Automation.

Build a бот to upload documents to Document Automation on page 2602
9. Transfer the Стандартные формы learning instance across different Document Automation

environments.
Transfer standard forms learning instance on page 2623

10. Check the learning instance assets (process, form, and боты) into the public repository. Then, deploy
the process and боты to unattended Bot Runner devices to begin processing documents in real time.
Publish the learning instance on page 2601

11. Validate the processed documents for the Стандартные формы learning instance.

Проверка загруженных документов

Evaluate your use case
Before processing documents in Document Automation, you must ensure that your documents are
Стандартные формы. After you confirm that your document meets the prescribed Стандартные формы
criteria, you can proceed with the type of extraction service required.
To determine if your use case meets the Стандартные формы criteria, review the following parameters:
• The layout of your document remains the same across vendors.
• The positions of various data elements such as checkboxes, tables, and so on, is fixed in your

documents.
• You have documents where the values are independent of other data elements.
• Your document is available in a supported language. Подробнее см. в разделе Azure Form Recognizer

Supported Languages.
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• Your document must have un-repetitive sections. In other cases, there must be a fixed number of such
repetitive sections that do not vary between documents.

• Your documents contain tables that have the same number of rows and columns.
• The document layout remains the same within the same year, across different organizations.

Проверка службы извлечения

After you have confirmed that the documents are Стандартные формы, you can then plan the type of
standard forms extraction service that fits your requirement. You can use the Microsoft Form Recognizer
service to process Стандартные формы in Document Automation. Before processing, ensure the following:
• Input documents can contain:

• Information with many details and have a reasonable quality resolution (>200 dpi)
• Check-boxes and radio buttons
• Handwritten content
• Signatures
• Таблицы

Note:  Input documents can also contain tables that span over a single page. However, if the
Стандартные формы contain table that spans across multiple pages, the content extraction can fail.

• No section of the input document is repeated.
• Documents that contain transpose tables.

Benefits of Microsoft Azure Forms Recognizer service

• Ability to process diverse standard form type documents.
• Auto detection feature can identify different types of tables, such as header-less tables, inverted tables,

and so on.
• Provides good support for handwritten forms.

Data Flow for Стандартные формы in Document Automation
The following data flow diagram shows how to configure Стандартные формы in Document Automation
using various components that facilitate the flow of data between Document Automation and the third-
party extraction service.
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• Labeling and model creation tool
You use the model creation tool to label and create models. In this diagram, the training documents are
uploaded in the tool and stored in the blob storage of the third-party service. To obtain the best results,
we recommend that you upload and label a minimum of five training documents to create a model.

• Blob storage
Blob storage is a storage unit that contains training documents and its related information.

• Extraction model
The trained models stored in the blob storage of the third-party service are fetched through APIs. The
Model ID, which can be a GUI ID or a standard name, is used to create the learning instance.

• Learning instance creation
You can browse and select the model to create a Learning instance. After you select the model, you can
upload a document for extraction to this Learning instance. The Learning instance accesses the third-
party extraction service to retrieve extraction results. The results either move to the output folder, or
the document moves to the validator.

• Extraction engine
The extraction engine performs extraction based on the model ID and returns the results to the
Learning instance.
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• Output results
Once the extraction is completed, the output results will include three components:
• extraction .csv
• auto detected table .csv
• response.json

Настроить службу извлечения
To extract content from Стандартные формы, you must setup and configure Microsoft Azure Form
Recognizer service.
Document Automation provides you with the option to get your own license key or purchase license from
Automation Anywhere. For more information on licenses, see Лицензии Automation 360 on page 1017.
1. Subscribe to Microsoft Azure service

Microsoft provides the Azure Form Recognizer service. This service enables you to build automated
data processing software that can identify and extract specific content from documents. You must
have Microsoft Azure subscription in order to access Azure resources (OCR, Form Recognizer),
Automation Anywhere provides access to these resources through its subscription. Contact your
Customer Success Manager (CSM) or Partner Enablement Manager (PEM) who will help you setup the
services.
Request access for Microsoft Azure resources (OCR and Form Recognizer) (A-People login required)

2. Setup Microsoft Azure Form Recognizer service
For Cloud deployment
• If you purchase the license from Automation Anywhere, no additional configurations or changes are

required.
• If you purchase the license from Microsoft Azure, review the following article to setup and

configure your Microsoft Azure Form Recognizer for extracting content from standard forms.
Setup Azure Form Recognizer and Storage (Cloud) (A-People login required)

Следующие шаги

Connect Document Automation with the extraction service. See, Configure Document Automation with
Microsoft Azure Form Recognizer on page 2617.

Configure Document Automation with Microsoft Azure Form Recognizer
Send an API request to connect Document Automation with the extraction service.

Note:  You will need the following information:
• Authorization token. См. Authentication API
• Microsoft Azure Form Recognizer endpoint
• Microsoft Azure Form Recognizer API key
• Microsoft Azure Blob storage URI

© 2023 Automation Anywhere. All rights reserved.     2617

https://apeople.automationanywhere.com/s/article/How-to-request-access-for-Azure-resources-OCR-Form-Recognizer
https://apeople.automationanywhere.com/s/article/Setup-Azure-Form-Recognizer-and-Storage
auth-api-supported.html


    Automation Anywhere - Оцифровка

For Document Automation Cloud:

Запрос

PUT <Cloud Host Url>/cognitive/v3/formrecognizer/config

Headers: X-Authorization - <IQBot Admin User Auth token >

Тело запроса:

{    "formRecognizerApi": <Cognitive Service
 Endpoint>,    "formRecognizerKey": <Cognitive Service
 apiKey>,    "blobStorageSas": <Azure blob storage SAS Uri> 
 }

}

For Document Automation on-prem:

Запрос

PUT <On-Prem Machine ip> / localhost/cognitive/v3/formrecognizer/config

Headers: X-Authorization - <IQBot Admin User Auth token >

Тело запроса:

{    "formRecognizerApi": <Cognitive Service
 Endpoint>,    "formRecognizerKey": <Cognitive Service
 apiKey>,    "blobStorageSas": <Azure blob storage SAS Uri> 
 }

Note:  The parameters are provided by the CloudOps team.

Следующие шаги

Log in as the Learning instance creator user to Create standard form in Document Automation on
page 2618.

Create standard form in Document Automation
Create a Стандартные формы extraction model in the Control Room.
• Ensure your Control Room has the Document Automation Стандартные формы (Number of pages)

product license
• You must have the AAE_Администратор IQ Bot or AAE_Службы IQ Bot roles to complete this

task
• Identify between five and fifteen training documents

1. In the Control Room, navigate to Manage > Learning Instances and click Create model.
The Projects window opens in a new tab.
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2. Click Create project.
3. Enter a name for the project, click Browse to upload documents to train the extraction model, and

click Create.
4. Define the field tags:

a) Click Add new tag.

b) Enter a name for the tag. For example, Invoice no. or Invoice Date.

5. Define the table tags:
a) Click Configure table tag.

b) Enter a name for the table.
c) For each column in the table, enter the name of the column under the Column fields section.

d) When you are done entering the columns names, click Save.
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6. Define the location of the data for each field:
a) For the form fields, highlight the location of the data to extract, then click the respective field in

the right panel.

b) For each row in the table, highlight the location of the data to extract, then click the respective
table field on the right.

c) Click Done, then open the next document and repeat the steps to define the locations of the
form and table fields.

7. Click the Train model icon, enter a name for the model, and click Train.

8. Click the Analyze icon, click Browse for file, and select a document to test the extraction model.

Next, Create a learning instance for standard forms on page 2620

Note:  You cannot edit an extraction model after associating it with a learning instance.

Create a learning instance for standard forms
Обучаемый экземпляр — это структура, содержащая такую информацию, как тип документа, язык и
поля для извлечения. After creating Стандартные формы, you must create learning instance to extract
data from the documents.
• Ensure your Стандартные формы configuration is complete.
• Ensure your Control Room has the Document Automation Стандартные формы (Number of pages)

product license

1. From the Control Room home page, navigate to Manage > Learning Instances > Create
Learning Instance.

The Create Learning Instance window opens in a new tab.

© 2023 Automation Anywhere. All rights reserved.     2620



    Automation Anywhere - Оцифровка

2. Add a name for the new learning instance to be created.
3. From the Document Type drop-down menu, select Standard Forms.

Note:  The provider name is selected as Microsoft Form Recognizer by default.

4. For model selection, click Browse and search for a model using name or description filter.
5. Select your model and click Next.
6. To proceed further, you must select atleast one field:

• Таблица
• Формы

Note:  Standard forms support multiple tables. However, Document Automation does not allow
displaying multiple tables. Hence, the tables are displayed as tablename:field name under Tables
tab.

7. Some other field attributes are as follows:
Вариант Описание

Имя поля Enter a field name that begins with an alphabetical character (A-Z
or a-z).
In standard fields, the field name is hardcoded and cannot be
changed.

Метка поля Enter a user-friendly name to help validators.
For example, you can rename Organization tax number to a
localized name, such as VAT number.
The field label does not affect extraction.

Достоверность Set a threshold to reduce potential false positives.
At the time of processing, the Document Automation engine
assigns a score to each field in a document to indicate the
certainty that the data was correctly extracted. If the document
contains fields with a score that is lower than the confidence
threshold, the document is sent to the validation queue.
If you enter a high confidence threshold, more documents will
be sent to the validation queue. If you enter a low confidence
threshold, fewer documents will be sent to the validation queue.
Supports values from zero to 100.
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Вариант Описание

Тип данных Choose from Address*, Text, Number, and Date.
If the data in the field does not match the data type, the
document is sent to the validation queue.
Document Automation supports variations of the date format.

Note:  If you are configuring a learning instance with a user-
defined document type, the form fields include the address data
type, which extracts the entire structure of an address.

Требуется Select one of the following:
• Required: Field cannot be empty.
• Необязательно. Field can be empty or not exist in the

document.

Правила проверки Depending on data type, create rules using patterns, formulas,
lists, and statements such as starts or ends with.
Starts With and Ends With on page 2529 | Шаблон on page 2529 |
Списки on page 2533 | Formulas on page 2534

8. Click Create.

When a new learning instance is created, the Control Room creates a folder with the
same name as the learning instance in the Automation > Document Workspace
folder. The folder contains two боты (extraction and download), a process, and a

form.
• Process: Manages the process using if/else scenarios through which Document Automation extracts

data from uploaded documents, assigns documents to users for validation, and downloads the
extracted data. To learn more, see About the AARI process in Document Automation on page 2589

• Extraction bot: Extracts data from defined fields in the uploaded documents.
• Download bot: Downloads the extracted data to a specific folder on the device or shared network.
• Form: Defines the input parameters that are sent to the process. Input parameters include the learning

instance name, uploaded file, and output file path.
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Upload documents to the learning instance, fix validation errors, and verify the extracted data: Process
documents in Document Automation

Transfer standard forms learning instance
Standard forms learning instance can be used across similar Document Automation environments. Export/
Import an existing learning instance to avoid creating another one with the same configurations.
• Ensure that the source and destination systems are running the same Document Automation version.

Learning instances from different Document Automation versions cannot be imported because their
database schema will not match.

• Back up your database before importing learning instances.
• Export the .dw file from the source Document Automation environment.
• Import the .dw file into the destination Document Automation environment.
•

Note:  The incoming model of the source system must be available in the configuration of the target
system.

For detailed information on exporting/importing learning instances, see Export/Import learning instances on
page 2613.
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Управление
As a Control Room administrator, create users and roles, and configure devices that access Automation
360. From the Control Room, you can also monitor and manage all activities to ensure a secure and
seamless бот execution environment for your users.

Activity and audit log

Monitor and manage automations, such as bot execution, scheduled and event trigger activities using the
Activity console (Activity from the left menu). You can also review and troubleshoot any failed activities
using the Audit log console (Administration > Audit log).
See the following pages for more information:
• Завершенные действия
• Scheduled activities
• Триггеры события
• Журнал аудита

The following short video shows how to check your бот runs:

Users, roles, and permissions

You can configure users and roles (role-based access control or RBAC) to provide access to specific
features and operations, based on their assigned roles. Creating users depends on whether the user is a
non-Active Directory, Active Directory, or single sign-on (SSO) user from an IdP server.
• Пользователи
• Функции

• Разрешения на использование для функции
• Бот permissions for a role

• Credentials and ячейки in the Credential Vault

Devices and queues

A device is the machine through which a user connects to the Control Room to create or run боты. Manage
devices that are registered to the Control Room from Manage > Devices.
A queue is a logical group of Work Items that are processed for automation by the Bot Runner from a pool
based on priority selected in the device pool and sort criteria configured in the queue.
• Устройства
• Управление рабочей нагрузкой
• Device pools
• Add queue, Bot Runner, and device pool
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Настройки

After initial setup of the Control Room, you (as an administrator) might have to set up and edit some
of the initial configurations to enable certain features. Go to Administration > Settings to configure
and edit settings for боты, пакеты, devices, email, network, user authentication, security, Git repository,
external key vault and so on.
The following image shows some of these

settings:
См. раздел Настройки.

См. также:

See the following pages for information on other features and settings:
• Bot Lifecycle Management
• Анализ кода
• CoE Manager
• Bot Store
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Задачи, связанные с данной
Планирование бот
Запланируйте запуск бот в определенное время.
Set up ячейка and assign credentials
Create a role, credentials, and ячейка to share related sensitive values with a group of users, so they can
use those values to build or run боты.
Create a role
As an administrator, you can configure roles with permissions to access features and perform operations
such as create, edit, or delete a бот in the Control Room, and assign the role to a user.
Create a user
Create a user and assign their specific license based role.
Set user device credentials
To enable a device for running боты, set the local device credentials.
Редактировать профиль
Manage user profiles.
Installing additional licenses
Upload new licenses to the Automation Anywhere Control Room to be distributed to users as required.

Действия
Monitor all ongoing automations and pause, stop, and resume them as required. Also, view the Bot Runner
(attended or unattended) trigger deployments in queue.

In-progress activity

Depending on the permissions granted by administrators, as a user, you can view and manage боты and
бот folders. With specific permissions, you can perform the following:

View everyone's activity from my folders With run or schedule permissions on folders, you
can view all бот activity started by other users from
those folders. This will be a super set in the View
my activity output.

Manage everyone's activity from my folders With run or schedule permissions on folders,
you can perform management activities, such as
Pause, Resume, and Stop on all бот activity
started by various users from those folders.

Based on the administrative permissions, you can apply various search parameters to monitor and find the
required in-progress activities.
The following table describes various search parameters, their description, and possible values or examples
to search the in-progress activities:
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Параметр Описание Possible values and examples

Status Search for an activity based on
its status.

• Started
• Active
• Paused
• Unknown
• Paused for input
• Pending execution
• Queued

Automation priority Search for an activity based
on the priority assigned to the
automation.

• Low
• Medium
• High

Current action Search for an activity based on
the current action.

User-specified action name

Current bot Search for an activity based
on the name of a бот that is
currently running.

User-specified бот name

Bot Search for an activity based on
the name of a бот.

User-specified бот name

Activity type Search for an activity based on
the activity type selected to run
a бот.

• Run Bot
• Import queue files
• Run bot with queue
• Export bots

Device Search for an activity based on
the device name on which it is
running.

User-specified device name

Прим.:  For troubleshooting a бот that stuck on the In progress activity page, refer BOT stuck in In
Progress Stage and not able to move it to history" or "BOT stuck in Pending execution Stage and not able to move it
to history" on Automation 360 CLOUD and On-Prem environments.

Действия

You can pause, resume, stop, move, export, and refresh the activities or items by using the actions in the
Historical page. Hover over the actions icon (vertical ellipsis) to enable and use the following actions:

Pause checked items To pause the selected items
Resume checked items To resume the selected paused items
Stop checked items To stop the selected items
Move checked items to history To stop the selected items
Move checked items to history To move the selected activity from In progress to

the Historical page.
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Прим.:  For Workload automation, you cannot
Stop, Pause/Resume, or Move checked items
to history if the TaskBot status is Active or
Unknown .

Export checked items to CSV To export selected items to a CSV file based on the
following parameters:
• Фильтры
• Выбор

Refresh table To refresh the table with updated activity details
Customize columns To show or hide specific columns

Важное замечание:  Multiple workload automation entries equaling the number of devices are shown
on the In-progress activity page if the work items added to a queue are fewer than the number of
devices available in a device pool. For details about a workload automation, see the View queue details
page on the user device on which the workload automation is deployed.

Завершенные действия
You can search, view, and run previously created боты in the Activity > Historical page.

Search parameters

Based on the administrative permissions, you can apply various search parameters to monitor and find the
required historical activities. The following table describes various search parameters, their description, and
possible values or examples to search the historical activities:

Параметр Описание Possible values and examples

Status Search for an activity based on
its status.

• Completed
• Failed
• Stopped
• Timed out
• Unknown
• Deploy failed
• Run failed
• Pending execution

Item name Search for an activity based on
triggered item.

A generic name in specif system
format with combination of your
бот name, date and time when
you run the bot, and username
by which you run the bot.
For example,
recorder_Recorder_2.7.3-20220527-004608.2022.07.04.09.32.16.botcreator
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Параметр Описание Possible values and examples

Automation priority Search for an activity based
on the priority assigned to the
automation.

• Low
• Medium
• High

Device name Search for an activity based
on the name of the device on
which the activity is running.

User-specified device name

Bot name Search for an activity based on
the name of a бот.

User-specified бот name

User Search for an activity based
on the name of the user who
created the activity.

User specified name

Действия

You can export, refresh, and customize the activity details in the Activity > Historical page.

Export checked items to CSV To export selected items to a CSV file based on the
following parameters:
• Фильтры
• Выбор

Refresh table To refresh the table with updated activity details
Customize columns To show or hide specific columns

Важное замечание:  Multiple workload automation entries equal to the number of devices are shown
on the Historical activity page, if the work items added to a queue are less than the number of devices
available in a device pool. For workload automation details, refer to the View queue details page on the
actual user device on which the workload automation was deployed.

Просмотр выполненных действий
You can view a list of all completed activities and corresponding information in the Activity > Historical
page.

Выполненные действия

You can use the Status search parameter and view all the completed activities in the Historical page.
You can export data in the table in CSV format, customize columns, and refresh the list in the table for the
completed activities.
Период хранения информации о выполнении бот на странице История варьируется в зависимости
от развертывания. Период хранения для различных развертываний указан в следующей таблице.

Развертывание Период хранения (в днях)

Community Edition 30
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Развертывание Период хранения (в днях)

Cloud 90

On-Premises Без ограничений (без автоматического
удаления)

Прим.:
• For On-Premises deployment, the бот execution information beyond the specified retention period is

available in the audit log and these logs are not deleted.
• For Cloud deployment, see  Automation 360 Cloud Data Retention Policy.

Прим.:
• Specify search parameters for the same column using OR operator.
• Specify search parameters for different columns, the system searches using AND operator.

You can perform the following actions for a table of completed activities:
• Sort the column items in ascending or descending order.
• Drag-and-drop columns to move or change the column sequence.
• Resize the column width.

Activity details

The following table describes various details for completed activities:

Параметр Описание Possible values and examples

Status Search for an activity based on
its status.

Completed

Item name Search for an activity based on
triggered item.

A generic name in specif system
format with combination of your
бот name, date and time when
you run the bot, and username
by which you run the bot.
For example,
recorder_Recorder_2.7.3-20220527-004608.2022.07.04.09.32.16.botcreator

Automation priority Search for an activity based
on the priority assigned to the
automation.

• Low
• Medium
• High

Device name Search for an activity based
on the name of the device on
which the activity is running.

User-specified device name

Bot name Search for an activity based on
the name of a бот.

User-specified бот name
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Параметр Описание Possible values and examples

User Search for an activity based
on the name of the user who
created the activity.

User specified name

Started on Дата и время начала
действия.

For example, 19:01:24IST
2022-06-06

Ended on The date and time when the
activity was ended.

For example, 19:01:40IST
2022-06-06

Last modified The time when activity was last
modified.

For example, 57 minutes ago or 3
weeks ago

Modified by The name of the user who
changes the activity.

User-specified name

Действия

You can view any individual item using the following action:

Просмотреть Просмотр сведений о выполненном действии.

Scheduled activities
Schedule боты to run on unattended Bot Runner from the Scheduled tab in the Control Room.

Обзор

Edit, view, activate, deactivate, delete a schedule, export selected activity details to a CSV file, and search
by activity name.
Perform the following actions on a column:
• Click a column to sort it in ascending or descending order.
• Use a drag-and-drop operation to move the column left or right.
• Move the mouse cursor to the end of the column and drag to re-size.

Schedule Actions

Perform the following tasks on an individual Schedule by moving your mouse over the Actions icon.

Планирование бот
Запланируйте запуск бот в определенное время.
Убедитесь, что вы вошли в Control Room как администратор или пользователь с указанными ниже
разрешениями.
• Планирование запуска моих боты
• Разрешение на планирование на уровне папок для определенных боты и их зависимостей
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• Доступ к пользователям, от имени которых выполняется задача (Bot Runner), которых вы можете
добавить в расписание

Прим.:  Автоматизация не будет работать в указанных ниже случаях.
• Если какая-либо из зависимостей бот отсутствует.
• Если у вас нет полномочий на работу с папками для зависимостей.
• Если у вас нет разрешений на планирование.

1. Navigate to Manage > Scheduled.
2. Щелкните Запустить бот.
3. Click Schedule bot.
4. Добавьте сведения о планировании для бот.

Прим.:  Значение Даты начала всегда будет позже или равно текущей дате. Если датой
начала является текущая дата, запланированное время не может предшествовать текущему
моменту времени.

Вариант Определение

Запустить однократно Чтобы запустить бот в указанное время,
введите перечисленные ниже данные.

Дата начала Значение по
умолчанию —
текущий день.

Время начала Значение по
умолчанию —
округление до
следующего
получаса.

Часовой пояс User's system time
zone
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Вариант Определение

Запускать несколько раз Чтобы запланировать запуск бот в указанное
время в определенный день, введите
перечисленные ниже данные.

Дата начала Значение по
умолчанию —
текущий день.

Дата окончания Это поле значений по
умолчанию пустое.

Время начала Значение по
умолчанию —
округление до
следующего
получаса.

Часовой пояс User's system time
zone

Прим.:
When the daylight saving is enabled and if the
Start date is set for a schedule, the Start date
is shown in the time zone to which it belongs
to and not as per the user's current time zone.
However, Next occurrence is shown in the time
zone (user's system time zone) as per daylight
saving time.
For example, for a schedule created on 15th
March in GMT time zone, the Start date is
shown as Mar-15th which belongs to GMT time
zone. Later, when daylight saving is ON and
if you edit or view this schedule in the month
of August in BST time zone, next occurrence
is shown as current August month date which
belongs to BST time zone.
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5. In the Missed schedule setting section, select Redeploy the schedule again to redeploy a
schedule that was missed because of Control Room shut down.

Прим.:  To ensure a successful deployment when using the Redeploy the schedule again option,
you must start the compiler service before you restart the Control Room services.

When the Redeploy the schedule again option is selected, schedules missed because of Control
Room shut down are automatically redeployed after the Control Room is restarted. An audit log entry
is also added showing the Event type as Schedule misfired.

6. Выберите бот для планирования.
• Последняя версия. Щелкните вкладку Последняя версия, чтобы выбрать последнюю

версию бот.
• Версия с меткой. Щелкните вкладку Рабочая версия, чтобы выбрать версию бот с меткой.

Доступные боты отображаются вместе с любыми входными значениями и зависимостями.
Если для родительского бот выбран вариант «Метка производства», то автоматически
выбираются также соответствующие зависимые боты с меткой производства. Если какие-либо
из зависимых боты не имеют метки производства, выбирается последняя версия бот.

7. Выберите пользователя Bot Runner из списка Доступные Bot Runner.
Use the following options to define the number of Bot Runner to use:
• All bot runners: Select to use all the selected Bot Runner.
• Custom number of bot runners: Select to customize the number of Bot Runner to use from the

list of selected Bot Runner. The Control Room will then automatically select the configured number
of Bot Runner from the list of available Bot Runner.

Прим.:  Если в списке нет пользователя, от имени которого выполняется задача, (Bot Runner),
убедитесь, что пользователю, планирующему боты, назначена функция, которая предоставляет
доступ к соответствующим пользователям, от имени которых выполняется задача.

8. Click the right arrow (→) to add your selection.
9. Необязательно: Select Device Pools.

Select the pool from the list of available device pools. If any of the selected run-as users does not
have the бот running device, a device pool is required. You can select up to 25 device pools per
schedule.

10. Необязательно: Click the up or down arrow to set the selected device pools in preferred order.
When a  is deployed, the  selects the first available device based on the order in which you organized
the device pools. If none of the devices are available at the time of deployment, the  is queued.
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11. Введите Имя.
12. Необязательно: Введите описание.
13. Выберите Приоритет автоматизации на вкладке Общие.

Установите высокий, средний или низкий приоритет в соответствии с вашими требованиями к
оптимизации ресурсов. По умолчанию для разрешения установлено значение «средний».

14. Click Schedule bot.

The Schedule bot option remains disabled until all the required items, such as боты, schedule details,
and devices are selected.
The number of times a бот is deployed depends on the run-as users (Bot Runner) selected for the
schedule. Consider the following scenarios:
• The number of run-as users selected is two, and both the users have the бот running device: The бот

is deployed twice on the two run-as users and their бот running devices.
• The number of run-as users selected is three, and only one of the users has the бот running device. In

this case, you must select the device pool. If the device pool has only two devices, the бот is deployed
three times on both the devices in the device pool and also on the бот running device of the third user.

• The number of run-as users selected is three, and none of the three users has the бот running device:
In this case, you must select the device pool. If the device pool has only two devices, the бот is
deployed twice on both the devices in the device pool, and the third request for бот deployment is
queued. The бот is deployed only when a device becomes available in the device pool.

• The number of run-as users selected is two, and none of the two users have the бот running device: In
this case, you must select the device pool. If the device pool has four devices, the бот is deployed twice
on any available two devices in the device pool.

Понятия, связанные с данным
Бот permissions for a role
Assign бот permissions when creating a role with the View my боты feature permission.
Задачи, связанные с данной
Edit a scheduled activity
Make changes to a schedule so that the automation is not skipped.
Delete a scheduled activity
Delete a scheduled activity.

Edit a scheduled activity
Make changes to a schedule so that the automation is not skipped.
Ensure that you are logged in to the  as the administrator.
Edit the scheduled activity in order to:
• Change the schedule type, date, or time.
• Add or remove Bot Runner from the schedule.
• Change the retry settings.

Прим.:  The system redeploys the боты and dependencies only if there are updates to the боты or its
dependent files.

1. Hover over the Actions icon for the scheduled  in the Activity table.
2. Click the Edit icon. ( )
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3. Make changes to the schedule details, боты, and devices, as required.
Вариант Определение

Запустить однократно Чтобы запустить бот в указанное время,
введите перечисленные ниже данные.

Дата начала Значение по
умолчанию —
текущий день.

Время начала Значение по
умолчанию —
округление до
следующего
получаса.

Часовой пояс User's system time
zone

Запускать несколько раз Чтобы запланировать запуск бот в указанное
время в определенный день, введите
перечисленные ниже данные.

Дата начала Значение по
умолчанию —
текущий день.

Дата окончания Это поле значений по
умолчанию пустое.

Время начала Значение по
умолчанию —
округление до
следующего
получаса.

Часовой пояс User's system time
zone

Прим.:
When the daylight saving is enabled and if the
Start date is set for a schedule, the Start date
is shown in the time zone to which it belongs
to and not as per the user's current time zone.
However, Next occurrence is shown in the time
zone (user's system time zone) as per daylight
saving time.
For example, for a schedule created on 15th
March in GMT time zone, the Start date is
shown as Mar-15th which belongs to GMT time
zone. Later, when daylight saving is ON and
if you edit or view this schedule in the month
of August in BST time zone, next occurrence
is shown as current August month date which
belongs to BST time zone.
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4. In the Missed schedule setting section, select Redeploy the schedule again to redeploy a
schedule that was missed because of Control Room shut down.

Прим.:  To ensure a successful deployment when using the Redeploy the schedule again option,
you must start the compiler service before you restart the Control Room services.

When the Redeploy the schedule again option is selected, schedules missed because of Control
Room shut down are automatically redeployed after the Control Room is restarted. An audit log entry
is also added showing the Event type as Schedule misfired.

5. Select Device pools.
Select the pool from the list of available device pools.

6. Необязательно: Click the up or down arrow to set the selected device pools in preferred order.
7. Необязательно: Change the Automation priority from the General tab.
8. Click Schedule bot.

The Schedule bot option remains disabled until all the required items, such as боты, schedule details,
and devices are selected.
The number of times a бот is deployed depends on the run-as users (Bot Runner) selected for the
schedule. Consider the following scenarios:
• The number of run-as users selected is two, and both the users have the бот running device: The бот

is deployed twice on the two run-as users and their бот running devices.
• The number of run-as users selected is three, and only one of the users has the бот running device. In

this case, you must select the device pool. If the device pool has only two devices, the бот is deployed
three times on both the devices in the device pool and also on the бот running device of the third user.

• The number of run-as users selected is three, and none of the three users has the бот running device:
In this case, you must select the device pool. If the device pool has only two devices, the бот is
deployed twice on both the devices in the device pool, and the third request for бот deployment is
queued. The бот is deployed only when a device becomes available in the device pool.

• The number of run-as users selected is two, and none of the two users have the бот running device: In
this case, you must select the device pool. If the device pool has four devices, the бот is deployed twice
on any available two devices in the device pool.

Задачи, связанные с данной
Планирование бот
Запланируйте запуск бот в определенное время.
Delete a scheduled activity
Delete a scheduled activity.

Delete a scheduled activity
Delete a scheduled activity.
Ensure that you are logged in to the  as the administrator.
To delete a scheduled activity:
1. Hover over the Actions icon for the scheduled  in the Activity table.
2. Click Delete.

Confirm or cancel.
3. Click Yes, delete.
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Задачи, связанные с данной
Планирование бот
Запланируйте запуск бот в определенное время.
Edit a scheduled activity
Make changes to a schedule so that the automation is not skipped.

Automatically select the number of Bot Runner users
Scale your automation by allowing Automation 360 to automatically select the Bot Runner users for specific
tasks.
You can enable Automation 360 to automatically select the Bot Runner users for specific tasks:
• Scale automations easily
• Run боты concurrently
• Use resources efficiently

You can optimize Bot Runner users by selecting how many Bot Runner you want to use to run tasks
concurrently. The system automatically selects the number of Bot Runner users that are available for the
tasks. As a result, when you run or schedule an automation, the available run-as users are automatically
selected from the specified list.
Let us consider the following example:
• You have three боты: Бот 1, Бот 2, and Бот 3.
• You have two Bot Runner licenses: bruser 1 and bruser 2.

You can use any of the Bot Runner users to run the three боты by performing the following procedure:
1. Create schedules to run these боты.
2. Select these боты to run.
3. Select both Bot Runner users.
4. Specify Custom number of bot runners to use as 1 so that one of the Bot Runner is used to run

these боты.
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See the following video on how Automation 360 automatically selects the Bot Runner users for specific
tasks:
To customize Bot Runner, see Планирование бот.

Триггеры события
An event trigger is a predefined action that runs an associated бот. All the боты with event triggers are
listed under the Event triggers tab.

Available role permissions for event triggers

A Control Room administrator must provide the required permissions to ensure the associated users can
access event triggers. The following table lists the available permissions:

Разрешение Описание

View event triggers Select this permission if the users can only view the event triggers but
not run or delete them.

© 2023 Automation Anywhere. All rights reserved.     2639



    Automation Anywhere - Управление

Разрешение Описание

Manage event triggers The Manage event triggers permission is available only if View
event triggers is enabled. Select this permission if the users can:
• Add an event trigger

Прим.:  Users associated with the Bot Creator license cannot add
event triggers in the private workspace.

• Run a бот with event trigger
• Delete event trigger
• Associate an event trigger with a Bot Runner (attended or

unattended) user or a role that is associated with one or more Bot
Runner (attended or unattended) users.

Supported actions

In Automation 360, click Manage > Event triggers to view the table that lists all the available боты with
event triggers. The following actions are available for this table.
• Enter a keyword from the BOT PATH in the Search field to find an event trigger.

For example, if the бот path of an event trigger is Bots\file--created--event--Salesinfo,
enter Sales in the Search field to find this event trigger.

• Use the Run with event triggers option to add event triggers.
Adding event triggers

• User can also delete any associated (active or inactive) event triggers.
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• View the trigger status, бот path, user name, role, and modification details.
Необязательно. On the specific device, to view trigger details:
1. Open the Task Manager > Details tab.
2. Right-click on the column in the list of app entries.
3. Click Select columns.
4. Click Command Line item to enable the column.

Verify that the following Java processes are running to confirm that the triggers are active:
• Бот agent or node manager

Прим.:  The name for this is java.exe

• Trigger listener

Прим.:  The name for this is javaw.exe

Необязательно. To confirm that java.exe or javaw.exe are associated with a node manager or
trigger listener, respectively:
1. Copy the details of this task

Press CTRL+C after you clicked the task name.
2. Paste the details to a notepad.
3. Verify the jar files.

Прим.:  Node manager is node-manager.jar and the trigger listener is triggerlistener.jar

Consider a scenario where triggers are associated with a Bot Runner user who logs off or signs out of
a device. This Bot Runner user must log in to the Control Room on that device in order to activate the
associated triggers.

Понятия, связанные с данным
Adding a trigger to run a бот
Add triggers that can automatically run the selected бот whenever a specific event occurs. For example,
clicking a specific button or using a combination of keystrokes.

Adding event triggers
Any бот with triggers can be associated with users or role to enable event trigger. Control Room user (or
role) with Manage event triggers permission can add event triggers.
All the боты a user creates are displayed in the Private tab. When the user checks in a бот to a public
folder, it is displayed in the Public tab.
A private event trigger is created when a user with the Manage event triggers permission adds a
trigger to a бот but does not check in this бот to a public folder. Private event triggers are listed under the
Manage > Event triggers page. However, if the user checks in the associated бот to a public folder, it is
no longer displayed under the Event triggers page.
1. На левой панели щелкните Автоматизация.
2. Щелкните Запустить бот.
3. Click Run with event triggers.
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4. Select the бот.
• Последняя версия. Щелкните вкладку Последняя версия, чтобы выбрать последнюю

версию бот.
• Версия с меткой. Щелкните вкладку Рабочая версия, чтобы выбрать версию бот с меткой.

Если для родительского бот выбран вариант «Метка производства», то автоматически
выбираются также соответствующие зависимые боты с меткой производства. Если какие-либо
из зависимых боты не имеют метки производства, выбирается последняя версия бот.

5. Click the right arrow (→) to add your selection.
6. Щелкните Вперед.
7. Выберите один из указанных ниже вариантов, чтобы связать бот.

Опция Описание

Функции Выберите созданную вами пользовательскую функцию.

Пользователи Выберите пользователя Bot Runner (с сопровождением или без
сопровождения), который связан с этой пользовательской функцией.

8. Click the right arrow (→) to add your selection.
9. Щелкните Вперед.
10. Click Run with event triggers.

The selected бот is added to the Event triggers page under Activity.
Понятия, связанные с данным
Working with боты
Depending on the license and permission assigned to you, you can perform various бот operations and
access the private and public workspaces in the Control Room.

Связывание триггеров событий с Bot Runner
An Control Room administrator or users with Manage event triggers permission can add event triggers
by associating users or roles with a бот. Это позволяет пользователям Bot Runner запускать бот, когда
происходит определенное событие.
После того как пользователь с лицензией Bot Creator создает бот и проверяет его в репозитории,
этот бот становится доступным в рабочей области Общие. Администратор или пользователь Control
Room с разрешением на выполнение действия Управление триггерами событий и доступом к
этой рабочей области Общие может выполнить привязку триггера события.
Пользователь Bot Runner (с сопровождением или без сопровождения) должен войти в Control
Room для запуска триггера события и может выбрать выход из системы после активации триггера
события.
По желанию администратор может включить функцию автоматического входа в систему в Control
Room для пользователей Bot Runner без сопровождения.
См. раздел Configure auto-login settings.

Прим.:  Среди всех триггеров можно связать какой-либо триггер только с пользователем, имеющим
лицензию Bot Runner. Кроме того, для пользователя с лицензией Bot Runner без сопровождения,
если связываются такие триггеры, как Горячая клавиша, Интерфейс или Окно, применяются
указанные ниже условия.
• Устройство по умолчанию не должно находиться в состоянии «выход из системы» или

«заблокировано».
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• Для выполнения предопределенной задачи, которая может инициировать бот, пользователь
должен войти в систему устройства.

1. На левой панели щелкните Автоматизация.
2. Щелкните Запустить бот.
3. Click Run with event triggers.
4. Select the бот.

• Последняя версия. Щелкните вкладку Последняя версия, чтобы выбрать последнюю
версию бот.

• Версия с меткой. Щелкните вкладку Рабочая версия, чтобы выбрать версию бот с меткой.

Если для родительского бот выбран вариант «Метка производства», то автоматически
выбираются также соответствующие зависимые боты с меткой производства. Если какие-либо
из зависимых боты не имеют метки производства, выбирается последняя версия бот.

5. Click the right arrow (→) to add your selection.
6. Щелкните Вперед.
7. Выберите один из указанных ниже вариантов, чтобы связать бот.

Опция Описание

Функции Выберите созданную вами пользовательскую функцию.

Пользователи Выберите пользователя Bot Runner (с сопровождением или без
сопровождения), который связан с этой пользовательской функцией.

8. Click Add event triggers.

Когда пользователь Bot Runner входит в Control Room и выполняет событие триггера,
развертывается бот. Триггер события будет работать до тех пор, пока не произойдет одно из
указанных ниже изменений.
• Из рабочей области «Общие» удаляется связанный бот.
• Удаляется связанная учетная запись пользователя Bot Runner.
• Происходит выход из системы устройства.

Устройства
Устройство — это компьютер, с которого пользователь подключается к Control Room, чтобы
создавать или запускать боты. Manage devices that are registered to the Control Room through the
Devices page located in the Manage tab.

Задачи, выполняемые на странице «Устройства»

As a Control Room user with Bot Runner, Bot Creator, and Device pools privileges, use the Devices page
to perform the following actions:
• Просмотр списка устройств, зарегистрированных и подключенных к текущему экземпляру Control

Room.
• Создание и просмотр списка групп устройств, доступных из текущего экземпляра Control Room.
• Немедленный запуск боты на выбранном Bot Runner.

If the device is already registered by another user other than the Bot Creator and the Bot Creator does
not have the Register device permission or the associated device assigned to it, when you run
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a бот from the бот editor window, the deployment fails with an insufficient permission error
message.

• Планирование запуска боты на выбранных Bot Runner.
• Запуск боты в выбранных группах устройств.

Прим.:
• Только пользователь с правами администратора имеет доступ к просмотру всех устройств в

Control Room. Пользователь без прав администратора не имеет доступа к просмотру Bot Creator.
• Только один Bot Creator может быть одновременно зарегистрирован на устройстве для запуска

боты. При создании нового пользователя Bot Creator на том же устройстве предыдущий Bot
Creator должен быть удален.

Устройства
На странице Устройства перечислены все настроенные устройства и текущее состояние каждого
из них. Устройства идентифицируются по IP-адресу и имени хоста. Устройство может находиться в
одном из указанных ниже состояний.

Подключено Устройство зарегистрировано в Control Room.

Прим.:  Подождите 35 секунд, чтобы устройство
отобразилось как подключенное в списке
устройств после удаления и повторной
регистрации устройства.

Отключено Устройство не зарегистрировано в Control Room.
В автономном режиме Устройство было снято с регистрации или

отключено администратором Control Room.

Доступны указанные ниже действия.

Подключить локальное устройство Install Bot Agent on your local device and connect it
to Control Room. In order to run боты on that local
device, ensure that you add it to the list of enabled
host devices.

Запустить бот сейчас с отмеченными
элементами

Запускает бот на выбранном устройстве.

Экспортировать отмеченные элементы в
CSV

Exports the data to a CSV file based on:
• Фильтры
• Выбор

Обновить таблицу Refreshes the table contents to view the updated
status.

Настроить столбцы Показать или скрыть определенные столбцы.
Просмотреть и редактировать устройства С помощью разрешения Просмотреть и

управлять ВСЕМИ устройствами можно
просматривать и редактировать указанные ниже
параметры.
• Имя
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• Статус
• Версия Bot Agent
• Имя группы устройств
• Псевдоним (необязательно)
• Описание
• Тип устройства (один пользователь или

несколько пользователей)
В случае многопользовательского устройства
можно изменить поле Поддержка
одновременных сеансов.

• Добавить или редактировать разрешения
устройства

• Разрешение экрана
Вы можете установить разрешение
экрана, выбрав заданное разрешение из
раскрывающегося списка или выбрать
пользовательскую настройку, указав
значения.
• Вы можете редактировать только поля:

псевдоним, описание, тип устройства и
разрешение экрана.

• Чтобы можно было менять разрешение
на уровне устройства, убедитесь, что
в настройках Control Room выбран
параметр Разрешать устройствам
переопределять настройки
разрешения.

Прим.:  The screen resolution settings are
applicable only when you use RDP-based
deployments. For regular deployments, a
Windows session is created using the existing
resolution settings of the device. In this case,
the screen resolution set in the Control Room is
ignored.

• Срок службы
Срок службы устройства может иметь
значение Постоянная или Временная.
Временные устройства создаются для
поддержки непостоянной инфраструктуры
виртуальных рабочих столов (VDI)
и автоматически удаляются через
определенное время, когда устройство
отключается от Control Room. Можно указать
время автоматического удаления временных
устройств в настройках устройств Control
Room.
Постоянные устройства создаются для
поддержки постоянной инфраструктуры
виртуальных рабочих столов (VDI) и не

© 2023 Automation Anywhere. All rights reserved.     2645



    Automation Anywhere - Управление

удаляются после отключения устройства от
Control Room.

• Параметры автоматического входа
Вы можете настроить параметры
автоматического входа для каждого
устройства. Выберите параметры,
настроенные в Control Room или на уровне
выбранного устройства, чтобы создать новые
сеансы пользователей или использовать
существующие сеансы пользователей после
завершения работы бот.

• Тип установки
Эта настройка зависит от того, как
установлен Bot Agent на устройстве
пользователя — на уровне пользователя или
на уровне системы.

• Тип развертывания
Эта настройка зависит от типа пользователя
и типа установки. Для отдельных
пользователей, установленных на уровне
системы, по умолчанию используется
обычный тип развертывания. Для нескольких
пользователей, установленных на уровне
системы, по умолчанию используется RDP.

Предварительная загрузка пакетов Используйте предварительно загруженные
пакеты для загрузки наиболее часто
используемых или настраиваемых пакетов
на локальное устройство. Поскольку пакеты
сохраняются на устройстве в автономном
режиме, при запуске бот система пропускает
процесс загрузки пакета и начинает выполнять
бот, тем самым сокращая время выполнения
бот. Вы можете загрузить определенные
версии пакета в папку устройства пользователя
C:\ProgramData\AutomationAnywhere
\AAPreloadedPackages.

Группы устройств

Группы устройств обеспечивают логическое группирование одинаковых Bot Runner для запуска боты
с рабочими операциями из очереди. Например, сгруппируйте устройства определенного отдела или
подразделения и создайте группу устройств для этого.
Задачи, связанные с данной
Установка Bot Agent и регистрация устройств
Install Bot Agent on your local device and connect it to Control Room. In order to run боты on that local
device, ensure that you add it to the list of enabled host devices.
Set user device credentials
To enable a device for running боты, set the local device credentials.
Configure auto-login settings
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Configure auto-login settings in the Control Room to either create user sessions or reuse existing user
sessions to reduce the бот startup time.

About multi-user devices
A multi-user device is any Windows terminal server device (Windows 2019, Windows 2016, Windows 2012,
Windows 10 Enterprise on Azure) which enables multiple users to concurrently log in to a single device.
The multi-user device server enables multiple users to access the same operating system and share the
hardware, performing the tasks for each user concurrently. In multi-user devices, боты are deployed using
RDP.

Benefits of a multi-user device

A multi-user device ensure that each machine in an organization is fully used, reducing the hardware and
software cost by enabling different users to access the same device. Bot Creator users and Bot Runner
(attended or unattended) users can be configured on a multi-user device. The multi-user device also
provides security and authentication for every user. Each user is assigned unique login credentials for the
device and can access only the assigned applications and device settings.

Прим.:  In a multi-user device, if two user sessions with the same device credentials try to deploy a бот,
the deployment will fail for one of the user sessions. An appropriate failure message is recorded in the
audit log.

Multi-user device in a device pool

A multi-user device can be part of a device pool and the device can be set as the default device for Bot
Creator users and Bot Runner (attended and unattended ) users.

Set as default device

As a licensed user, when you log in to a non-default device, you can set that device as your default device.
You must have the View and manage ALL device(s) permission if you want to set another device that
is not registered by you as your default device: To set it as the default device, follow these steps:
1. Click the device icon on the top-right of your screen.
2. Select the Make default device option from the menu.

If you do not have the necessary permission, a message prompt appears, stating that you will lose access
to your current default device.

Configure RDP-based deployment for multi-user devices
RDP-based deployment is used for multi-user devices. When a бот is deployed for an unattended Bot
Runner from the Control Room, the Control Room handles the unattended Bot Runner session through
RDP and executes the бот.
Ensure that you are logged in to the Control Room as the administrator.
Обеспечьте выполнение приведенных ниже требований.
• Active Directory Domain Services are set up (Optional).
• Remote Desktop Services (RDS) are set up on the machine ready to host multiple (RDS) bot runner

sessions (Mandatory).
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• Active Directory/Local users are created (Mandatory).
• Users are provided access to RDS (Mandatory).

When registering your device, you can register it as a multi-user device.
1. Change device type to multiple users.

a) Navigate to Manage > Devices.
b) Hover over the actions menu (three vertical ellipses) located to the right of the device name and

click the Edit device icon.
c) Under Deployment tab, change the Device type to Multiple users.
d) Enter a value for the Concurrent sessions supported field.

The maximum number of allowed concurrent sessions depends on your device license type and
the hardware configuration. For example, consider that concurrent sessions is set to 10 and
each бот requires 4 GB RAM for execution. If your system RAM is lower than this value, the бот
execution might fail.
Also, if the maximum number of sessions allowed in your device is 10 and the multi-user device
is set as the default device for 3 Bot Creator users and 2 attended Bot Runner users, then the
value for the concurrent sessions supported will be 5. Therefore, at a time, only 5 боты can be
deployed concurrently by the unattended Bot Runner users. So ensure that your hardware and
device license type support the number of sessions you set.

e) Щелкните Сохранить изменения.

2. Set the RDP screen resolution.
This ensures your automation runs seamlessly during RDP-based deployment, even if the resolution of
the screen varies between the Bot Runner and Control Room.
You can set it in the following ways:
• At the Control Room level: Configure screen resolution for a device session.
• At the device level: Устройства.

Note that you can update the screen resolution at device level only if the option to override screen
resolution is enabled in Administration > Settings > Devices.

3. Configure the RDP settings.
a) Select Devices option from Administration > Settings.
b) Edit the RDP settings for multiple user devices field.
c) Enter the Port.

Прим.:  Use the default port 3389 for RDP-based бот deployments.

d) Enter the RDP session timeout value.
The default session timeout value is 60.

e) Щелкните Сохранить изменения.
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4. By default clipboard data is shared across RDP sessions. Follow the below steps to prevent sharing of
clipboard data across multi-user RDP sessions:
a) Select Devices option from Administration > Settings.
b) Edit the Advanced options field.
c) In the RDP command options field, enter -clipboard.
d) Щелкните Сохранить изменения.

For more information about troubleshooting black screen and lock screen images, see
• Black screenshot while running the bot in unattended mode (A-People login required)
• Black screen and lock screen images being captured (A-People login required)

1. Create users in the Control Room.
These users can be unattended Bot Runner, Attended Bot Runner, or Bot Creator. You can select the
multi-user option when you register the device for the first time. См. раздел Create a user.

2. Associate the correct device and session login credentials based on the Active Directory users that you
create before configuring the multi-user device settings.
You can register an Active Directory user one time as an admin user and the sessions are created
when you deploy боты. You do not have to create an RDP session on the Bot Runner server and
register the device under an Active Directory user name and user credentials.

3. Deploy the боты on parallel sessions.

Прим.:  If the multi-user device per sessions count provided is less than the actual бот deployment,
then the additional бот deployments are queued until the current deployments are in progress.

Convert an existing device to a multi-user device
If you have a server OS, multi-user OS, or hosted VMs such as AWS, Microsoft Azure, or VMware as the
Bot Runner machine, you can convert your existing device to a multi-user device.
Ensure that you are logged in to the  as the administrator.
Converting a device enables you to share the same device between Bot Runner and Bot Creator users
because they can coexist in different sessions simultaneously. Also, multiple parallel executions of a бот
can be performed on the same machine.
If you encounter Auto Login issues because multiple users are sharing the device or because it is a remote
device, convert your device to a multi-user device.
If you have a single-user device and want to use RDP-based deployment, then set the device type as
Multiple users and Concurrent sessions supported to 1.
1. Navigate to Manage > Devices.
2. Hover over the actions menu (three vertical ellipses) located to the right of the device name and click

the Edit device icon.
3. Under Deployment tab, change the Device type to Multiple users.
4. Enter a value for the Concurrent sessions supported field.

The maximum number of allowed concurrent sessions depends on your device license type and the
hardware configuration. For example, consider that concurrent sessions is set to 10 and each бот
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requires 4 GB RAM for execution. If your system RAM is lower than this value, the бот execution might
fail.
Also, if the maximum number of sessions allowed in your device is 10 and the multi-user device is
set as the default device for 3 Bot Creator users and 2 attended Bot Runner users, then the value
for the concurrent sessions supported will be 5. Therefore, at a time, only 5 боты can be deployed
concurrently by the unattended Bot Runner users. So ensure that your hardware and device license
type support the number of sessions you set.

5. Щелкните Сохранить изменения.

About device pools
Device pools are a logical grouping of devices or similar unattended Bot Runner machines on which you
can run your workload management automations or scheduled unattended automations. For example, you
can group the devices (system-wide type) of a specific department or unit and create a device pool.

Обзор

You can use a device pool to restrict бот deployments to a specific set of devices that are available from
your Control Room instance and take advantage of any device available in a device pool because any
device in the device pool can run the бот.
You can also use a device pool to process work items from workload management queues. Workload
management distributes work items across various devices in a device pool. This distribution of work items
ensures efficient бот processing through optimal usage of devices and Automation 360 licenses. Device
pools can contain different types of devices, such as single-user devices or muti-user devices.
You can share the device pool between multiple automations such as workload management, Run bot,
and Schedule bot, thus improving the device utilization.

How a device pool works

When you deploy an unattended бот to a device pool at run time, system identifies the available devices
from the pool. System starts with first device from the pool, if the first device is busy, it checks for next
device and then the бот is automatically sent to the available device from the list of system-wide devices.
As the other боты are deployed, they can run concurrently on the other devices in the device pool. By
dynamically allocating devices when боты are deployed, бот deployments are executed quickly and
efficiently.

High availability (HA) in device pools

Device pools provide built-in High Availability (HA) for the Bot Runner machines if your unattended
license is free to use. You are not tied to a single Bot Runner machine, so if your Bot Runner machine is
unavailable for any reason and your unattended license is free for deployment, your automation is not
affected. The scheduled automation will automatically run on the next available Bot Runner machine,
thereby providing high availability.

Прим.:  Consider the following points when working with user credentials:
• Only one user credential can be attached to a licensed user.
• If all devices in a device pool are domain integrated and Active Directory users have access to all

devices, licensed users can login to any device by using attached user credentials.
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• For more information about running bots in device pool, see Considerations for running a бот.

Managing device pools

As a device pool administrator, you can create, edit, and view all device pools that can be used for
scheduling automations and workload management.
As a device pool owner or consumer, you can view only those device pools of which you are the owner
or consumer. Only users with the AAE_Queue Admin and AAE_Pool Admin role can perform device
management tasks.

Прим.:  You have to create device pools to view those in the list.

To easily access your device pool, you can search by a device pool name.
• Click a column to sort it in ascending and descending order. You can sort up to three columns by

holding the Shift key when you click two more columns. This enables you to sort two additional
columns. The sorting is done on the entire table and not just the data that is currently visible to you.
The last sorting is stored in memory applied by a user per session.

• Use a drag-and-drop operation to move the column left or right.
• Move your mouse cursor at the end of the column and drag to resize.

Create device pools
Create a device pool with a unique name and add Unattended Bot Runner to the device pool.
• Ensure that you have one of the following roles to view the Device Pools tab:

• Device pool owner
• Device pool admin

• Ensure that you have a role with Create device pools permission to create a device pool.

Прим.:  A Control Room administrator without device pool admin rights cannot view or create a device
pool.

• To add a device in the device pool, you must install it as a system-wide device (Bot Agent).
• After you add the device, you cannot add the same device to another device pool.

• You can add only those Unattended Bot Runner that are not part of any other pool.

Ограничение:  Unattended Bot Runner that are a part of other device pools are disabled for
selection.

• You can use the Scheduled automations and Run with Queue automations options to run боты
on that device.

• You can add Control Room user roles as consumers. Only users with these roles can use the pool for
any automation.

• You can select only those devices with the Bot Runner installed at the system wide.
• If the devices in a device pool are more than the number of work items added to a queue, multiple

entries equal to the number of devices are shown in the Control Room In-progress activity and
Historical pages. For details, refer to the View queue details page on the actual user device on
which the workload automation is deployed.
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To create a device pool, perform the following steps:
1. Navigate to Manage > Device pools.
2. Click Create device pool.
3. Введите Имя.
4. Необязательно: Введите описание.
5. Select the Devices from the list of .
6. Click the right arrow (→) to add your selection.
7. Щелкните Вперед.
8. Select the Device Pool Owners.
9. Select user(s) from the Available users list.

Совет:  Search the list of users based on their Username, First name, or Last name.

10. Click the right arrow (→) to add your selection.
11. Щелкните Вперед.
12. Необязательно: Select the Device Pool Consumers.

Complete this step to enable device pool consumers to view the device pool when they run the
automation for the bot with a queue by following the next set of steps.

13. Необязательно: Select a Role from the list of Available roles.
14. Click the right arrow (→) to add your selection.
15. Click Create device pool.

The device pools for which you have consumer privileges are listed in the My Device Pools page.
View device pool details
Задачи, связанные с данной
Запуск бот с очередью
Совместная обработка всех рабочих операций очереди на всех Bot Runner, присутствующих в одной
или нескольких группах устройств.

View device pool details
As a Control Room user with device pool management privileges or as a device pool owner, you can view
device pool details to ensure the information provided is correct and if required customize as per your
automation requirement.
Ensure that you are logged in to the  as the administrator.
Use the Device pool details page to view automations that are scheduled to run with or without
workload. The following information is displayed as part of device pool data:

Несколько видов автоматизации Shows the automations that are using the device
pool and the order that is chosen to run those.
This is shown as the default view. To find an
automation quickly, use the search option using
Status, Automation name, Queue, or Activity type.
You can perform the following actions on a table
column:
• Click a column to sort it in ascending and

descending order. You can sort up to three
columns by holding the Shift key when you click
two more columns. This enables you to sort
two additional columns. The sorting is done on
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the entire table and not just the data that is
currently visible to you. The last sorting is stored
in memory applied by a user per session.

• Use a drag-and-drop operation to move the
column left or right.

• Move your mouse cursor at the end of the
column and drag to resize.

Устройства Shows list of unattended Bot Runner devices that
are part of the device pool.

Владельцы Shows list of device pool owners that are granted
permission to view, edit, and delete the device pool.
Create device pools

Потребители Shows the list of device pool consumers who are
granted permission to view the device pool as an
option to running automations.
Create device pools

Общая информация Shows the last modified date and time, name of
the user who modified device pool details, and
the Object Type which is the component on which
modification was done.

The Scheduled Automations tab is selected by default. Automations that are created using Run bot
now or Schedule bot (upcoming schedules) on that device pool are listed.
The second tab, Run with Queue Automations lists the automations that are scheduled to run for
Workload using the option Run bot with queue.
To view device pool details:
1. Navigate to Manage > Device pools.
2. Hover over the Actions icon for the device pool and select View.

Select each tab to view the related details.

Edit device pools, or Запуск бот с очередью.
Задачи, связанные с данной
Create device pools
Create a device pool with a unique name and add Unattended Bot Runner to the device pool.
Delete device pools
Delete a device pool comprising of unattended Bot Runner after your entity's automation goals are
achieved and the device pools are no longer required.

Edit device pools
As a Control Room user with device pool management privileges or as a device pool owner, you can edit
device pool details to customize your automation requirements.
• You must have Device pool owner or Device pool admin roles to edit a device pool.
• Users without AAE_Admin role must have the following permissions to edit a device pool:

• View and manage ALL device(s) to add or delete the devices
• View Users and Roles basic information to add or delete the owners and consumers

• To add a device in the device pool, you must install it as a system-wide device (Bot Agent).
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• After you add the device, you cannot add the same device to another device pool.

When you open the device pool in edit mode, you can update the queue details such as Bot Runner,
Owners, Participants, and Consumers.
1. Go to Manage > Device Pools.

The Device Pools tab is visible only if you have Device pool admin role or you are an owner of any
device pool.

2. Locate the device pool you want to edit, hover over the actions menu (vertical ellipsis), and click Edit.
You can also edit the device pool details in view mode. For more information, see View device pool

The Device pool details page is displayed with the default Scheduled Automations tab.
3. Set the Queue Execution mode to edit workload automations.

Go to the Run with queue automations tab, then choose one of the following options to define the
order in which your automations run in the queues:
• Round robin: Runs your automations at equal time intervals in the Time slice field. Подробнее

см. в разделе Циклический перебор.
• Priority as shown in table: Runs your automations based on a priority defined in the priority

table. Подробнее см. в разделе Приоритет так, как отображено в таблице.

4. Update the list of unattended Bot Runner devices that are included in the device pool.
5. Update the list of device pool owners who are granted permission to view, edit, and delete the device

pool.
6. Update the list of device pool consumers who are granted permission to view the device pool.
7. Щелкните Сохранить изменения.

Задачи, связанные с данной
Create device pools
Create a device pool with a unique name and add Unattended Bot Runner to the device pool.
Delete device pools
Delete a device pool comprising of unattended Bot Runner after your entity's automation goals are
achieved and the device pools are no longer required.
View device pool details
As a Control Room user with device pool management privileges or as a device pool owner, you can view
device pool details to ensure the information provided is correct and if required customize as per your
automation requirement.

Order of the automation queue
You can define the order in which your automations run in the queues.
This topic describes options of orders in which you can run the automation queues.

Циклический перебор

This option runs your automations at equal time intervals specified in the Time slice field. You can set a
Time slice in seconds, minutes, or hours and you can calculate or estimate the time for each automation,
and then provide this number.
• The default time slice is 60 minutes.
• The time slice cannot be set to zero.
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Automations are executed for 60 minutes first, then the system checks for other automations in queue
for execution. If there are other automations in the queue, that automation is paused and the next
automation is executed. This method continues until all automations in the queue are executed.

Приоритет так, как отображено в таблице

With this option, automations run based on a priority defined in the priority table. You can run automations
in the order of priority and set the individual priorities for each of the queues. Priority 1 is the highest
priority and that queue is processed first and completely by the device pool. Then the device pool moves
onto the processing queue with Priority 2. When the queue with Priority 2 is processed completely, the
device pool proceeds to processing queue with Priority 3, and so on. Automations are processed until all
automations are consumed from the specified automation queue.

Прим.:  This option is available only on the Run with queue automations tab.

Delete device pools
Delete a device pool comprising of unattended Bot Runner after your entity's automation goals are
achieved and the device pools are no longer required.
Ensure that you are logged in to the  as the administrator.
You can choose to delete your device pools in either of two ways:
• Delete one device pool
• Delete multiple or all device pools

If the device pool is being used for workload automation, you will not be allowed to delete it.
1. Navigate to Manage > Device pools.
2. Select the device pool(s) to delete.

Select the device pools to delete or select all device pools by selecting the Select All check box in the
header.

3. Hover over the Actions icon for the device pool.
4. Click Delete.

Confirm or cancel.

Задачи, связанные с данной
View device pool details
As a Control Room user with device pool management privileges or as a device pool owner, you can view
device pool details to ensure the information provided is correct and if required customize as per your
automation requirement.
Create device pools
Create a device pool with a unique name and add Unattended Bot Runner to the device pool.

Пакеты
Users with the Manage package permission can upload and manage packages.Automation Anywhere
provides you with the flexibility to decide which packages you want to make available to the Bot Creator
for creating боты.
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Users must have the appropriate administrative permission to view or manage action packages.

Просмотреть пакеты A user with View packages permission can view
the packages that are available to Bot Creator.
Go to the Bots > Packages page to view All
packages.
The All packages page lists all the packages in
the Control Room that are available for Bot Creator.
Packages can have multiple versions.

Управлять пакетами A user with the Manage packages permission
can add new packages to the Control Room and
manage which packages versions are available in
the Control Room.
Add packages from the Bots > Packages > Add
package.
Manage packages from the Bots > Packages >
All packages > View package page.

Установить по
умолчанию

Select a package and
set is as the default.
As soon as a package
is set to default, it is
the package that all Bot
Creator in the Control
Room use.

Выключить Disable a package so
that users cannot use
it to create new боты.
Боты that were created
using a package that is
disabled also fail to run.

Удалить Deleting a package
removes the actions
contained in the
package from the
Control Room for all
users.

Важное замечание: 
A package cannot be
deleted if it is being
used by a бот.

Прим.:  It is recommended that Bot Creator update боты to use the latest version of a package.

Updates to packages by Automation Anywhere are available in each release of Automation 360. The latest
updated package can be set to the default package by users and administrators with Manage package
permission.

Прим.:  When you upgrade to Automation 360 v.24, the Apache log4j2 library is no longer bundled
in the command пакеты. Однако более старая команда пакеты, начиная с Automation 360 v.23 и
более ранних версий, может продолжать использовать объединенную библиотеку log4j2. Если вы
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хотите использовать команду пакеты без объединенной библиотеки log4j2, мы рекомендуем вам
использовать в ваших задачах новую версию Automation 360 v.24 с командой пакеты.

RBAC on пакеты
Based on the business requirements and expertise of developers, administrators can restrict пакет access
for a simplified developer experience, along with the capability to enforce access policies for custom
groups.

Обзор

The RBAC feature helps you to set access at the пакет level to restrict usage and execution of пакеты to
improve security. This feature can be applied to all пакет types, including custom пакеты where you can
control assigning and managing the пакеты to your users.
RBAC access to пакеты applies only to the task of creating боты. If a user role does not have access to
a particular пакет, these users cannot view the пакет on the Actions palette and therefore cannot use it
when creating боты. However, these users can run боты (created by a different user who has access to
the пакет) that uses the пакет.
• Each developer sees only the approved list of пакеты in their workspace.
• Some пакеты might be available for all users, while some are available only for certain groups.

The following image shows how RBAC can be set for user roles and groups:

Benefits of пакеты RBAC

• Centralized policy enforcement for secure, user-friendly developer access: Role-based access
to automation provides enhanced security, confidence, and ease of use for developers.

• Enterprise-wide access policy: Establish group-based пакет access with clear policies restricting
пакет access to all the users or users with specific roles.
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• Access based on business needs: Create required access groups, expose group-appropriate library
of пакеты, and manage the phased rollout of пакет access.

• Simplified automation for citizen developers: Hide complex пакеты from the action palettes for
citizen developers so that they can focus on easy-to-complete automation.

• Automation reuse with compliance: Enable users to create utility боты from complex пакеты to
use as cloned боты in the a private workspace or inside public боты.

The following image lists the benefits of пакеты RBAC:

User types

Administrator • Customizes пакеты so that they are accessible
to developers based on the developers'
expertise, skill, business group, and more.

• Creates custom groups and assign access per
group.

• Rolls out пакеты in a phased manner to different
types of developers.
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• Provides better control over how пакеты are
made available to developers. Пример.
• New developers can avoid causing security

risks as they do not have access to complex
пакеты.

• Advanced developers can get broader access
to пакеты.

An organization can enforce centralized control
over пакет access and best practices through
this feature.

Roles and permission required: Administrators
with the View Users and Roles basic
information and Manage packages permission.

Бот developer • Gets a customized view of пакеты in their
workspace.

• Simplified (easy-to-use) пакеты are enabled for
Citizen Developers so that they can build a basic
functional task бот using actions and пакеты
available in their actions palette.

• Advanced developers can get access based on
the entitlements or privileges provided by the
administrator.

Roles and permission required: Users with the
View Users and Roles basic information and
Manage packages permission.

See the following video for an overview of how RBAC is configured:

Configure RBAC for пакеты
Restrict пакеты usage based on your business needs and roles for a secure and simplified developer
experience. An administrator can customize access to пакеты based on developers' expertise, experience,
and so on, while бот developers get a customized view of пакеты in their workspace based on their
expertise and needs.
You must be an administrator or a user with the View Users and Roles basic information and
Manage packages permission.

1. Войдите в Control Room.
2. Перейдите в раздел Управление > Пакеты.
3. From the list of пакеты, search for the пакет for which you want to give access to the users.
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4. Click the selected пакет.

For example, when you click the Recorder пакет, the selected пакет window opens.
5. To allow specific users to use the пакет from the Bot editor, go to the Availability tab and click Edit.
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6. On the Configure package availability page, choose one of the following options:
• All user: Select this option to allow the user to use the пакет while creating боты. By default, this

option is selected for all the пакеты.
• User with selected roles: Select this option if you want users with selected roles to access the

пакет and use it while creating боты.
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7. To configure access for specific users, perform these steps:
a) Select the User with selected roles option.
b) From the available roles, select the roles you want to assign.
c) Move the selected roles to the right panel.

This step enables you to define users who will have access to the пакет in the Bot editor.
d) Щелкните Подтвердить.

The availability tab shows the selected roles for whom the specific пакет is now enabled.
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Пакеты RBAC for бот developer
As a Bot Creator (RPA developer) or Непрофессиональный разработчик, you can create боты based on
the пакеты that are available to you.
You can use only those package-defined actions, triggers, variables, and customized пакеты for which you
have access. Your access to these пакеты are set by the administrator based on user roles. If you do not
have access to a пакет, you cannot view that пакет on the Actions palette.
RBAC on пакеты applies when you create or edit боты in your private workspace. You cannot run боты
with restricted пакеты directly. However, you can use a cloned бот as a sub бот in another main бот and
run this бот in a public or private workspace.
When a бот contains пакеты (or пакеты that you cannot access), keep in mind these considerations:
• You cannot perform these бот actions:

• Run a бот: Either a new бот or a checked-out бот with changes
• Check in a бот
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If you try to perform these actions, an error message is displayed that the бот contains пакеты that are
restricted.

• While editing variables, you cannot use variable property options related to restricted пакеты.
An error message is displayed that the variable is related to a пакет that is restricted.

• You cannot run a бот with triggers:
• From the Bot editor, when you run a бот with a trigger that contains a restricted пакет, see an error

message is displayed that the бот with triggers contains a restricted пакет.
• When a trigger event is configured for a user and a device, and the trigger event occurs on the

device, access to the бот пакет is verified. If the бот contains a restricted пакет, the бот fails, and
an audit log entry is recorded.

Add пакеты to the Control Room
Administrators can add packages to the Control Room for use by Bot Creator.
Ensure that you are logged in to the  as the administrator.
You can add a package from either Bot Store or another source.
To add a package from a source other than Bot Store, follow these steps:
1. Перейдите в раздел Управление > Пакеты.
2. Click Add package.
3. Щелкните Обзор.
4. Locate and select the пакет to add to the Control Room.

Пакеты are Java Archive (JAR) files that contain actions used to create боты.
5. Click Upload package.
6. On the Bots > Packages > Confirm package page, choose any of the following options:

• Accept, enable and set as default: Uploads and enables the selected пакет, and sets it to the
default пакет for the Control Room.

• Accept and enable: Uploads and enables the пакет, but the пакет is not set as the default
пакет. Bot Creator have to specifically select non-default пакеты to use them for creating боты.

• Accept but disable: Uploads and disables the new пакет.

Choosing Reject stops the upload process.
To add a package from Bot Store, see the following video:

7. After installation, click Administration > Packages to verify that the пакет is added.
When you add or update a пакет in the Control Room, a notification is also sent through the
Notifications icon. This notification is sent to the Control Room users who have the View package
permission. For more information, see Add or update пакет event notification.

Понятия, связанные с данным
Build and test a demo package and бот
This practical how to section demonstrates that creating, changing, and managing packages allow you to
customize actions and efficiently manage packages for all Control Room users.
Задачи, связанные с данной
Manage Control Room packages
Manage packages in the Control Room by setting a package as default, disabling it, or deleting it.
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Manage Control Room packages
Manage packages in the Control Room by setting a package as default, disabling it, or deleting it.
Ensure that you are logged in to the  as the administrator.
To manage packages in the Control Room, users must have Manage package permission.
Package management actions apply to all users; however, the user can select specific package versions
within a бот.
1. Перейдите в раздел Управление > Пакеты.
2. Hover over the Actions icon for the package.
3. Click View.
4. Choose any of the following options:

Опция Описание

Установить по умолчанию Select a package and set is as the default. As
soon as a package is set to default, it is the
package that all Bot Creator in the Control Room
use.

Прим.:  By default, new versions of пакеты
become the default version and will only be used
the first time that пакет is used in editing a бот.
If a бот already uses the пакет, it continues to
use an earlier version.

Выключить Disable a package so that users cannot use it to
create new боты. Боты that were created using a
disabled package continue to work.

Удалить Deleting a package removes the actions
contained in the package from the Control Room
for all users.
You can delete a пакет version if:
• A Control Room user with Manage package

permission added the пакет version. However,
you cannot delete any пакет versions that
were automatically installed by the system,
or through a Control Room new installation or
upgrade; you can only disable them.

• The пакет version is not in Default status.
• The пакет has only one version, but its status

is Default.

Важное замечание:  A package cannot be deleted if it is being used by a бот.

Понятия, связанные с данным
Пакеты
Users with the Manage package permission can upload and manage packages.Automation Anywhere
provides you with the flexibility to decide which packages you want to make available to the Bot Creator
for creating боты.
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Задачи, связанные с данной
Add пакеты to the Control Room
Administrators can add packages to the Control Room for use by Bot Creator.

Обновление боты до версии пакет по умолчанию
Вы можете выполнить массовое обновление существующих боты в репозитории Control Room, чтобы
установить версию по умолчанию для любого пакет. Эта функция обеспечивает быстрое обновление
до безопасной и стабильной версии пакет для всех боты.
• To update боты to the default пакет version, ensure you have the View пакеты permission and the

permission to edit боты.
Когда вы начнете процесс массового обновления, будут обновлены все боты, для которых у
вас есть разрешение на выгрузку, а также те боты, которые не используют версию пакет по
умолчанию.

• Убедитесь, что боты совместимы с текущей версией пакет по умолчанию.
• При обновлении боты до версии пакета по умолчанию, убедитесь, что боты не будут выгружены

до завершения процесса.
• Не отключайте пакет, когда идет процесс массового обновления.

Прим.:
• Массовое обновление боты для использования версии пакет по умолчанию может повлиять на

производительность репозитория Control Room или других функций Control Room.
• When you perform bulk updates to existing боты to set the default versions for пакеты, ensure that

you wait until the bulk update process for one пакет is completed and only then start updating another
пакет.

1. Перейдите в раздел Управление > Пакеты.
2. Найдите пакет, который вы хотите обновить для боты.
3. Чтобы установить версию пакет по умолчанию для всех боты в общей рабочей области,

щелкните Обновить боты до версии пакета по умолчанию.
4. В окне Обновить боты до версии пакета по умолчанию введите указанную ниже

информацию.
• Имя действия: название инициированного процесса массового обновления версии пакет

для всех боты.
Если на странице журнала Аудит выбрать Запрошено обновление пакета по
умолчанию для бота или Выполнено обновление пакета по умолчанию для бота
для просмотра сведений об имени элемента, то имя действия отображается как название
запроса с его значением.

• Описание: при необходимости вы можете добавить описание для этого действия.
• Комментарии о загрузке: это поле уже заполнено сведениями о версии пакет, который вы

обновляете.
Вы можете ввести полезный комментарий, который пригодится для будущего использования.
Этот комментарий о загрузке будет виден на странице Просмотреть историю. Например,
перейдите в раздел Автоматизация > Общедоступная > папка > Task Bot. Щелкните
по вертикальному многоточию и выберите Просмотреть историю TaskBot, чтобы увидеть
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сообщения о массовой загрузке для новых версий боты, созданных с помощью массового
обновления.

Прим.:  Выполнение массового обновления не повлияет на существующие или
запланированные запуски бот. Для запланированных запусков боты с меткой «Производство»
будет продолжаться развертывание рабочей, а не последней версии.

5. Щелкните Обновить боты.
6. Щелкните Да, продолжить.

Система начнет обновлять все боты в репозитории Control Room, которые используют пакет.
Если какие-либо из боты не используют версию пакеты по умолчанию, то эти боты будут
обновлены.

7. Перейдите в раздел Администрирование > Журнал аудита.
8. На странице Журнал аудита выполните поиск по типу события Обновление пакета по

умолчанию.
Просмотрите необходимую информацию, например начало запрошенного процесса,
отдельные боты, которые обновляются с помощью версии пакет по умолчанию, и завершение
запрошенного процесса. Для получения этой информации вы также можете просмотреть в
Журнале аудита следующие имена элементов:
• Запрошено обновление пакета по умолчанию для бота
• Список боты, которые обновляются, например бот Payrollprocess2022
• Выполнено обновление пакета по умолчанию для бота

9. Чтобы просмотреть сведения обо всех боты, которые обновлены для использования версии
пакет по умолчанию, скопируйте ID запроса со страницы Выполнено обновление пакета
по умолчанию для бота. На странице Журнал аудита выполните поиск по фильтру ID
запроса и введите нужное значение.
Например, d6adb0724340666e. На странице Журнал аудита отображаются все боты, которые
успешно обновлены во время процесса Обновить ботов до версии по умолчанию. В список
также входят боты, для которых обновление завершилось сбоем.

10. Чтобы просмотреть сведения о каждом имени элемента на странице Журнал аудита,
выполните следующие действия.
a) Щелкните Запрошено обновление пакета по умолчанию для бота и просмотрите

указанные ниже сведения.
• Сведения о событии: отображает такую информацию, как данные пользователя,

отправившего запрос, сведения об устройстве пользователя, идентификационный номер
запроса, дату и время инициированного запроса, а также сведения о версии пакет,
которая будет обновлена для всех боты.
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• Обновление информации о пакете по умолчанию: отображает такую информацию,
как имя запроса, изменения в версии пакет, имя пакет для обновления, а также версию
пакет, которую вы сейчас используете.

В зависимости от пакет, все боты, использующие выбранный пакет, будут обновляться по
очереди.

b) Щелкните любой бот, чтобы просмотреть следующую информацию.
• Имя запроса: отображает имя инициированного запроса.
• Путь к боту: отображает путь к файлу или папке, в которой находится бот.
• Имя пакета: отображает название пакет.
• Старая версия пакета: отображает предыдущую версию пакет.
• Версия целевого пакета: отображает версию, до которой обновляется пакет.
• Старая версия бота: отображает более старую версию бот.
• Новая версия бота: отображает текущую версию бот, для которой выполняется

обновление.

Во время процесса массового обновления для некоторых боты обновление до версии
пакет по умолчанию может завершиться сбоем. Такие бот отображаются на странице
Журнал аудита со статусом «Неудачно». Например, если боты выгружаются во время
обновления пакет, то для этих боты обновление версии пакета не будет выполнено и
операция завершится сбоем.

c) Щелкните Выполнено обновление пакета по умолчанию для бота, чтобы
просмотреть следующую информацию после завершения процесса массового обновления:
• Количество боты, которые успешно обновлены.
• Количество боты, которые не удалось обновить из-за ошибок времени компиляции, или

боты, которые выгружены в процессе обновления пакет.
• Количество пропущенных боты.

Если боты используют одну и ту же версию пакет, они будут отображаться как
пропущенные в процессе обновления.

• Номер старого пакета пакет и номер целевой версии пакет (по умолчанию).

Чтобы ознакомиться с примером этой процедуры, см. Example of updating default пакет version across
боты.

Administrator settings
Control Room administrators manage settings related to the database, Credential Vault, users, roles, action
packages, licensing, and more.
Задачи, связанные с данной
Create a role
As an administrator, you can configure roles with permissions to access features and perform operations
such as create, edit, or delete a бот in the Control Room, and assign the role to a user.
Create a user
Create a user and assign their specific license based role.
Installing additional licenses
Upload new licenses to the Automation Anywhere Control Room to be distributed to users as required.
Создать учетные данные
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Create a credential and add the required attributes.

Журнал аудита
View logs and details to record user activities.
Audit Log displays a read-only table of records of actions performed by users. These log records are
searchable and exportable. Audit logs include both Successful and Unsuccessful actions attempted.

Действия

The following Audit log actions are enabled:

Прим.:  Use your cursor to roll over the action button icons to identify specific functions.

Time filter Users select from preset time filters or configure
a custom time filter for log entries to view. The
default time filter setting is Last 24 hours.

Искать Search the records. Select additional search filter
criteria from the drop-down menu.

Совет:  To search the exact phrase, enclose the
search phrase within double quotes (for example,
"Taylor-Finance-564").

Экспортировать отмеченные элементы в
CSV

Export the data to a CSV file based on filters and or
selections.

Обновить Refresh and view the updated status.
Настроить столбцы Показать или скрыть определенные столбцы.
Просмотреть To view details of a table entry, mouse over the

entry to expand and click Audit details.

Audit log table

View the following audit details in the table.

Table item Описание

Статус Shows action status.

Время Shows the date and time of the action
performed.

Event Type Shows the type of action performed.

Имя элемента Shows the entity on which action was performed.

Event Started By Shows the user that performed the action.

Source Device Shows the device or machine name or IP
address that was used to perform the action.
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Table item Описание

Источник Shows the component: Control Room, Enterprise
Client or API, from where the action originated
or was performed.

ID запроса Shows the unique identity number assigned to a
specific set of user actions.

Bot life cycle audit logs

The entry shows the status of each stage of the бот life cycle.

Audit log entry Успешно Failure

Создать автоматизацию Бот was sent to the control
room and was successfully
compiled.

Check if the Control Room is up
and running.

Бот Sent To Device Control Room deployed the бот
successfully on the specified
device.

Possible reasons for failure
entry include:
• Check if you have configured

the Node manager on
the corresponding device
correctly.

• Check for the app
Automation Anywhere Bot
Manager in Add Remove
Programs or in Control
Panel > Uninstall a
program. Try to reinstall by
uninstalling and downloading
the app again.

• Try to reinstall by
uninstalling and downloading
the app again from Device
Manager.

• Ensure the device auto log in
details are set correctly.
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Audit log entry Успешно Failure

Run бот Deployed The бот has started on the
specified device.

Possible reasons for failure
entry include:
• Check if you have configured

the Node manager on
the corresponding device
correctly.

• Check for app Automation
Anywhere Bot Manager in
Add Remove Programs
or in Control Panel >
Uninstall a program.

• Try to reinstall by
uninstalling and downloading
the app again from Device
Manager.

• Ensure device auto log in
details are set correctly.

Run бот finished Бот execution completed
successfully.

Possible reasons for failure
entry include:
• Check for the бот execution

progression in Activity In
progress.

• Check the code at the line
where activity log has been
paused for errors.

• If it has paused at a
message box, minimize
all windows and check if
the message box is in the
background.

Bot Runner Session Continued Control Room deploys the
TaskBots in a sequence for the
same RDP session.

Bot Runner Session Released When a task successfully
completes the execution.

Download file Downloading to the Control
Room.

Upload file Uploading a file to the Control
Room.

Bot Runner Session Control Room gets the RDP
session of Bot Runner machine.
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Syslog audit log

For on-premises deployments, the SysLog Configuration audit entry shows the Control Room server
status when adding, editing, or deleting the system configuration. The Syslog details shows these
attributes and their values:
• Syslog Server Hostname: Full qualified domain name (FQDN) or the IP address of the Syslog server

used to deliver the log reports
• Port: Port used by the remote Syslog server to receive incoming Syslog records
• Protocol: TCP or UDP
• Use Secure Connection: TLS encrypted channel used to send Syslog records to the remote Syslog

server

Audit log entry Статус User action SysLog details
shows these
attributes and
their values

Успешно Adds new values to an existing
server

• Syslog Server
Hostname

• Порт
• Протокол
• Использовать

безопасное
подключение

Пример.
MyServer1.aa.com,
468, TCP,
Enabled

SysLog Configuration

Успешно Adds new values to multiple
servers

• Syslog Server
Hostname

• Порт
• Протокол
• Использовать

безопасное
подключение

Пример.
MyServer1.aa.com,
468, TCP,
Enabled

MyServer2.aa.com,
333, TCP,
Disabled
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Audit log entry Статус User action SysLog details
shows these
attributes and
their values

Успешно Edits existing server • Syslog Server
Hostname

• Порт
• Протокол
• Использовать

безопасное
подключение

Пример. Old
ValueMyServer1.aa.com,
468, TCP,
Enabled

New Value
MyServer123.aa.com,
514, UDP,
Disabled

Успешно Deletes existing server • Syslog Server
Hostname

• Порт
• Протокол
• Использовать

безопасное
подключение

Пример.
MyServer1.aa.com,
468, TCP,
Enabled

SysLog Configuration Неудачно User attempted to save the
system configuration; however,
the Control Room was not able
to save the configuration.

For an unsuccessful
status, you can
use the results to
troubleshoot the
issue. Examples:
Invalid
Protocol, or
Could not
save SysLog
settings.
Invalid Host.

External key vault audit log

For cloud deployments, the External key vault configuration audit entry shows the type of external key
vault configured (if any). Automation Anywhere supports these external key vaults:
• Диспетчер секретов AWS
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• Хранилище ключей Azure
• CyberArk Password Vault

Based on the type of external key vault configured, the external key vault configuration details shows
different attributes and their values.

Audit log entry Внешнее
хранилище
ключей

User action Configuration
details shows
these attributes
and their values

Диспетчер
секретов AWS

Adds a new AWS Secrets
Manager when there was
previously no external key
vault.

• External key
vault value:
Changes from
no external
key vault to
AWS Secrets
Manager.

• AWS Secrets
Manager value
is Enabled

• Region value
is set to (for
example) us-
east-1

External key vault
configuration

CyberArk Adds a new CyberArk Password
Vault when there was
previously no external key
vault.

• External key
vault value:
Changes from
no external
key vault to
CyberArk.

• CyberArk value
is Enabled

• Vault URL is the
CyberArk AIM
server CCP API
URL and is set
to (for example)
https://
<hostname:port_num>/

• Application ID
is the CCP API
AppID and is set
to (for example)
AAEControlRoom
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Audit log entry Внешнее
хранилище
ключей

User action Configuration
details shows
these attributes
and their values

Azure Key vault Adds a new Azure Key vault
when there was previously no
external key vault.

• External key
vault value:
Changes from
no external
key vault
to Azure Key
vault.

• Azure Key
vault value is
Enabled

• Vault URL is the
Azure Key Vault
URL and is set
to (for example)
https://
user-db-
vault.vault.azure.net/

• Client ID is the
(application)
ID of an App
Registration in
the tenant and
is set to (for
example)536145

• Tenant ID is the
Azure Active
Directory tenant
(directory) ID
and is set to (for
example)89D12L

External key vault
configuration

Change from AWS
Secrets Manager to
CyberArk

User changes from one
external key vault to another
type.

External key vault
value changes from
AWS Secrets
Manger to
CyberArk

Automation Anywhere Robotic Interface (AARI) Audit logs

The entry shows the status of events relating to requests, teams, scheduler, process setups, bot setups,
human tasks, and bot tasks that you have created, deleted, updated, submitted, or recovered.

Audit log entry Успешно

AARI Team • When a team is created by a user
• When a team is edited by a user
• When a team is deleted by a user
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Audit log entry Успешно

AARI Request • When a request is deleted by a user
• When a request is recycled by a user
• When a request is recovered by a user

AARI Human Task • When a task is edited by a user
• When a task is submitted by a user
• When a task is canceled by a user
• When a task is assigned by a user to another

user
• When a task is canceled (using a cancel type

of action by a user or by a bot (AARI Web
package))

AARI Бот Task When the process launched a bot task

AARI Process • When a process is created
• When a process is edited by a user

AARI Бот Setup • When a new bot is added to the bot setup
management

• When the bot setup management is modified
• When a bot is deleted by a user

Process Scheduler When the scheduler configuration is modified

Audit events list
Review the list of audit events to identify the type of audit entries that are logged in the Control Room for
Automation 360.

General audit entries

The following table shows a list of general audit entries and their descriptions (listed alphabetically):

Записи аудита Описание

Accept end user license agreement This action is logged when the user accepts the
license agreement.

Активировать автоматизацию This action is logged when the user activates the
schedule.

Добавить учетные данные This action is logged when the user creates
credentials.

Add Global value This action is logged when the user creates a
new global value.

Добавить ячейку This action is logged when the user creates the
locker.
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Записи аудита Описание

Добавить ручную зависимость This action is logged when the user adds manual
dependency to a бот.

Add MFA token This action is logged when the user adds the MFA
(multi-factor authentication) token.

Назначить лицензию This action is logged when the user creates
a user with a particular license (such as Bot
Creator or Bot Runner) and when the user
changes the license from Бот. This action is
logged when the user creates a user with a
particular license (such as Bot Creator or Bot
Runner) and when the user changes the license
from Bot Creator to Bot Runner and vice versa.

API-Key duration This action is logged when the user changes the
duration for how long a generated API-Key is
valid to authenticate users.

Ошибка аудита This action is logged when an audit error occurs.

Аудит переноса окончен This action is logged when migration is
completed.

Аудит переноса начат This action is logged when migration is started.

Audit unset activity type This action is logged when there is an unset
activity type.

Automation complete This action is logged when a schedule completes.

Auto-login credentials not set This action is logged when auto-login credentials
have not been set for the user.

BOT_AGENT_BULK_INSTALLATION This action is logged when the user changes the
option to generate a registration key to perform
bulk installation of Bot Agents on multiple
devices.

Бот runner session This action is logged when a Bot Runner session
occurs.

Бот saved This action is logged when a user saves a бот
or modifies a бот that is checked in to a Git
repository.

Бот sent to device This action is logged when a bot is sent to a
device.

Бот sent to device failed due to configuration
update

This action is logged when a bot fails to be
sent to a device because a device configuration
upgrade is in progress.

Бот validation setting This action is logged when a user sets the bot
validation setting.

Callback request This action is logged when a callback is
requested.

Callback URL validation failed This action is logged when the callback URL is
invalid and does not appear on the white list.
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Записи аудита Описание

Certificate authentication configuration create This action is logged when a user creates
certificate authentication settings.

Certificate authentication configuration update This action is logged when a user modifies the
certificate authentication configuration.

Certificate authentication TLS host configuration
create

This action is logged when a user creates
a certificate authentication TLS host server
configuration.

Certificate authentication TLS host configuration
reinstall

This action is logged when a user reinstalls
a certificate authentication TLS host server
configuration.

Certificate authentication TLS host configuration
update

This action is logged when a user modifies
a certificate authentication TLS host server
configuration.

Изменить настройки This action is logged when the user changes any
setting such as On to Off, or Off to On.

Загрузить… This action is logged when a check in occurs.

Check in request This action is logged when a check in is
requested.

Выгрузить… This action is logged when a checkout occurs.

Check out request This action is logged when a check out is
requested.

Вход клиента This action is logged when a client logs in.

Клонировать… This action is logged when a user clones an
object.

Cloud burst mode This action is logged when a cloud burst occurs.

Cloud-enabled provisioning success This action is logged when a cloud is successfully
provisioned.

Cloud-enabled provisioning failure This action is logged when cloud provisioning
fails.

Configure credential vault This action is logged when a user configures a
credential vault.

Connect credential vault This action is logged when a user connects a
credential vault.

Control Room configurations This action is logged when a user edits general
configuration settings to the Control Room.

Control Room upgrade available This action is logged when an upgrade to the
Control Room is available.

Control Room upgrade email notification This action is logged when an email has been
sent to indicate a successful upgrade to the
Control Room.

Control Room upgrade failure This action is logged when an upgrade to the
Control Room has failed.
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Записи аудита Описание

Control Room upgrade success This action is logged when an upgrade to the
Control Room has completed successfully.

Создать автоматизацию This action is logged when the user creates a
new schedule or runs a бот with a queue in
workload management.

Создать бот This action is logged when the user creates a бот
for the first time.

Создать домен This action is logged when the user creates a
new domain.

Создать черновик очереди This action is logged when the user saves the
work item as draft in workload management.

Создать папку This action is logged when the user creates a
new folder.

Создать экземпляр для обучения This action is logged when the user creates a
new learning instance.

Создать пакет This action is logged when the user creates a
new package.

Создать учетные данные прокси-сервера This action is logged when the user creates new
proxy credentials.

Создать очередь This action is logged when the user creates a
new queue in workload management.

Не удалось создать очередь This action is logged when a queue creation fails.

Создать функцию This action is logged when the user creates a
new role.

Создать пользователя This action is logged when a new user is created.

Создать рабочий элемент This action is logged when new work items are
added to a queue.

Не удалось создать рабочий элемент This action is logged when new work items failed
to add to a queue.

Credential vault settings This action is logged when a user defines
credential vault settings.

Деактивировать автоматизацию This action is logged when the scheduled
automation is deactivated.

Удалить автоматизацию This action is logged when the user deletes the
schedule.

Удалить бот This action is logged when the user deletes a
bot.

Удалить учетные данные This action is logged when the user deletes
credentials.

Delete device This action is logged when the user deletes a
device.

Удалить файл This action is logged when the user deletes a file.
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Записи аудита Описание

Удалить папку This action is logged when the user deletes a
folder.

Delete Git settings This action is logged when the user deletes Git
repository settings in the Control Room.

Удалить глобальное значение This action is logged when the user deletes the
global value.

Delete learning instance This action is logged when the user deletes an
existing learning instance.

Удалить ячейку This action is logged when the user deletes a
locker.

Delete MFA token This action is logged when the user deletes the
MFA (multi-factor authentication) token.

Удалить учетные данные прокси-сервера This action is logged when the user deletes proxy
credentials.

Удалить очередь This action is logged when the user deletes the
queue in workload management.

Не удалось удалить очередь This action is logged when the user fails to delete
a queue.

Удалить функцию This action is logged when the user deletes roles
from the system.

Delete tenant BLM clean up This action is logged when the Bot Lifecyle
Management (BLM) performs clean up for a
deleted tenant.

Удалить пользователя This action is logged when the user delete users
from the system.

Удалить рабочий элемент This action is logged when the user deletes the
work item from the queue.

Не удалось удалить рабочий элемент This action is logged when the user fails to delete
work items in a queue.

Deployment automation This action is logged when a bot is deployed to
run.

Развертывание поставлено в очередь This action is logged when a deployment has
been queued to run.

Устройство получено пользователем This action is logged when the device has been
acquired by the user.

Device configuration update initiated This action is logged when the user initiates the
device configuration update.

Device details updated This action is logged when the device details
have been successfully updated.

Device not available to acquire This action is logged when the device is
unavailable to be acquired by the user.
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Записи аудита Описание

Устройство зарегистрировано This action is logged when the user registers a
device.

Обновление устройства настроено This action is logged when the user changes
the option to install or update the Bot Agent
software.

Device type update settings This action is logged when the settings of a
device type are updated.

Отключить пакет This action is logged when the user disables a
package.

Отключить пользователя This action is logged when the user disables
another user in the system.

Сброс учетных данных домена This action is logged when the user resets or
reconnects to the Active Directory domain from
the settings page.

Скачать бот This action is logged when a user downloads a
bot.

Download bot finished This action is logged when the Bot Store
completes downloading a bot.

Загрузить файл This action is logged when a user downloads a
file.

Редактировать бота This action is logged when the user renames a
бот.

Редактировать домен This action is logged when the user modifies a
domain.

Edit learning instance This action is logged when the user edits any
of the following settings of an existing learning
instance:
• Edits the name
• Edits or adds a description
• Uploads staging documents
• Adds new fields
• Edits new group setting
• Edits default validations groups setting

Редактировать функцию This action is logged when the user modifies a
role.

Edit role - folder permissions This action is logged when a user changes the
folder permissions of an existing role.

Edit settings This action is logged when the user modifies
settings.

Редактировать пользователя This action is logged when the user modifies
another user.
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Записи аудита Описание

Резервное копирование эластичного поиска This action is logged when the user provides a
backup IP address in the Elasticsearch disaster
recovery backup cluster.

Elasticsearch delete index This action is logged when the user deletes an
index from the Elasticsearch.

Уведомление по электронной почте This action is logged when email notification
connection or authentication fails.

Настройки уведомления по электронной
почте

This action is logged when the user modifies
email notification settings.

Empty pools This action is logged when there are empty pool
IDs.

Включить пакет This action is logged when the user enables a
package.

Включить пользователя This action is logged when the user enables
another user in the system.

Выполнить автоматизацию This action is logged when the user executes a
bot.

Экспортировать бот This action is logged when the user exports a
bot.

Экспортировать домен This action is logged when the user exports any
of the domains from the IQ Bot application.

Экспортировать экземпляр для обучения This action is logged when the user exports
a learning instance ( .iqba file) through the
migration utility.

Export queue This action is logged when the user exports a
queue from workload management.

Export request This action is logged when the user generates an
export request.

Export to csv This action is logged when the user exports data
to a csv.

Failed to acquire user or device This action is logged when the device or user is
unavailable to be acquired.

Failsafe status updated This action is logged when a failsafe status has
been updated.

Настройки загрузки файлов This action is logged when the user changes the
file upload settings to restrict or allow the upload
of executable files to a malicious file upload.

First Administrator settings This action is logged when a user configures the
first Administrator user in the Control Room.

Force unlock bot This action is logged when a user unlocks a bot.

Отчет GDPR This action is logged when a user enables GDPR
(General Data Protection Regulation) reporting.
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Записи аудита Описание

Создать API-ключ This action is logged when an Admin user
generates an API key from the My Settings
page, which can be used to obtain an
authentication token. This audit entry shows the
generate API key status as either Successful or
Unsuccessful.

Передача Git This action is logged when the user synchronizes
information between the built-in Git repository
and the remote Git host.

Восстановление Git This action is logged when the user restores all
of their bots and associated dependent files from
the Git repository to a new database.

Прерывание восстановления Git This action is logged when the user aborts to
restore all of their bots and associated dependent
files from the Git repository to a new database.

Сброс восстановления Git This action is logged when the user resets to
restore all of their bots and associated dependent
files from the Git repository to a new database.

Import bot This action is logged when the user imports a
bot.

Импортировать домен This action is logged when the user imports any
new domains to IQ Bot. 

Импортировать экземпляр для обучения This action is logged when the user imports
a learning instance ( .iqba file) through the
migration utility.

Import queue This action is logged when the user imports a
queue into workload management.

Import request This action is logged when the user generates an
import request.

Установить лицензию This action is logged when the user installs or
changes the license from the license page.

Доступ к IP-адресу This action is logged when the IP address has
been accessed.

Миграция лицензии This action is logged when a license is migrated
to another user.

License mode change This action is logged when the user changes the
license mode.

Загрузить рабочие элементы из файла This action is logged when the user selects a
CSV or Excel file and uploads the work item in a
queue.

Log in banner settings This action is logged when an Admin configures
banner text to display on the login page of the
Control Room.

Перенос окончен This action is logged when a migration
completes.
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Записи аудита Описание

Перенос начат This action is logged when a migration begins.

Переместить автоматизацию в журнал This action is logged when the user moves the
selected activity to the Historical page.

No access to pool This action is logged when a user has no access
to a device pool.

Override Global value This action is logged when users override a
global value with their own private value.

Настройки паролей This action is logged when an Admin configures
password settings for the Control Room.

Прочитать учетные данные This action is logged when the logged-in user
accesses the credentials of another user for
which they do have permission for because the
user is not a consumer for the credential or a
credential owner.

Прочитать ячейку This action is logged when the logged-in user
accesses the locker of another user for which
they do not have permission because they
are not part of a locker as a member (owner,
manager, participant, or consumer).

Зарегистрировать приложение This action is logged when the user configures IQ
Bot.

Освободить лицензию This action is logged when the user changes the
license from Bot Runner to Bot Creator or Admin.

Release user license This action is logged when the user changes the
user license.

Удалить ручную зависимость This action is logged when the manual
dependency is removed from a бот.

Переименовать папку This action is logged when the user renames the
folder.

Повторно отправить сообщение для проверки
по электронной почте

This action is logged when the email is resent for
verification.

Сбросить пароль This action is logged when the user resets the
password.

Revert checkout This action is logged when the user reverts a
previous check out action.

Откатить This action is logged when the user rolls back to
a previous version.

Используется запуск от имени пользователя This action is logged when the user runs a bot as
the user using the bot.

Run as user invalid This action is logged when a user who tries to
run aand use the bot is invalid.

Запуск автоматизации This action is logged when the user runs an
automation.
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Записи аудита Описание

Save allowed IP addresses This action is logged when the allowed IP
addresses have been saved.

Расписание пропущено This action is logged when the Control
Room services starts or the server is available
after more than 15 minutes of scheduled
deployment time.

Security Settings - External key Vault -
Configuration

For cloud deployments, this action is logged
when a user makes a change to the external
key vault configuration. Automation Anywhere
supports these external key vaults: AWS Secrets
Manager, Azure Key Vault, and CyberArk. This
audit entry shows the status as either Successful
or Unsuccessful.

Security Settings - Network settings This action is logged when the user changes the
configuration of the allowed IP address from
where the authentication is restricted.

Отправить бот в производство This action is logged when the user moves the
bot from staging to production.

Отправить бот в промежуточное
расположение

This action is logged when the user moves the
bot from production to staging.

Отправить сообщение электронной почты This action is logged when an email is sent.

Send learning instance to production This action is logged when the user moves the
learning instance from staging to production.

Отправить экземпляр для обучения в
промежуточное расположение

This action is logged when the user moves the
learning instance from production to staging.

Session timeout settings This action is logged when the settings of a
session timeout is reached.

Set default device This action is logged when the user sets the
default device.

Задать учетные данные устройства This action is logged when the user sets the
device credentials.

Set Git settings This action is logged when the user sets remote
Git repository settings in the Control Room.

Sync license This action is logged when a license is synced.

SysLog Configuration For on-premises deployments, this action is
logged when a user adds, edits, or deletes Syslog
server configuration. This audit entry shows the
Control Room server recording the status as
either Successful or Unsuccessful.

Temporary devices cleanup job This action is logged when the temporary device
runs its cleanup job.

Проверить подключение прокси-сервера This action is logged when proxy connectivity is
tested.
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Записи аудита Описание

Время ожидания This action is logged when an operation times
out.

Тренировочный бот This action is logged when the user creates a
training bot.

Передать право на учетные данные… This action is logged when the locker admin
transfers the ownership of the credentials.

Trigger bot run This action is logged when a bot runs due to a
trigger.

Trigger bot run fail This action is logged when a bot fails to run due
to a trigger.

Trigger delete This action is logged when a trigger is deleted.

Не удалось удалить триггер This action is logged when the deletion of a
trigger fails.

Trusted CA key store update This action is logged when a user modifies
the trusted CA key store for certificate
authentication.

Unable to send bot device This action is logged when a bot fails to be sent
to a device.

Undo checkout This action is logged when the user reverses a
check out.

Unlock credential vault This action is logged when the user unlocks the
credential vault.

Unset default device This action is logged when the user changes the
default device.

Обновить регистрацию приложения This action is logged when the IQ Bot URL is
updated in the settings page.

Обновить автоматизацию This action is logged when the user edits the
schedule automation.

Update callback URL failed This action is logged when the callback URL list
has failed to update.

Update callback URL successful This action is logged when the callback URL list
has been updated successfully.

Обновить учетные данные This action is logged when the user modifies the
credentials.

Update device auto download packages This action is logged when the device updates its
auto download packages settings.

Обновить учетные данные устройства This action is logged when the device updates its
credentials.

Update device general settings This action is logged when the device updates its
general settings.

Update device log settings This action is logged when the device updates its
log settings.
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Записи аудита Описание

Update device RDP settings This action is logged when the device updates its
RDP (Remote Desktop Protocol) settings.

Update device resolution settings This action is logged when the device updates its
resolution settings.

Update Git settings This action is logged when the user updates
remote Git repository settings in the Control
Room.

Update Global value This action is logged when the user updates an
existing public global value.

Обновить ячейку This action is logged when the user modifies the
lockers.

Update MFA role This action is logged when the user modifies the
MFA (multi-factor authentication) role.

Update MFA settings This action is logged when the user modifies the
MFA (multi-factor authentication) settings.

Update MFA token This action is logged when the user modifies the
MFA (multi-factor authentication) token.

Update MFA user This action is logged when the user modifies the
two-factor authentication for a user.

Обновить пакет This action is logged when the user updates an
existing package.

Update package settings This action is logged when the user updates any
package settings.

Обновить учетные данные прокси-сервера This action is logged when the user updates
existing proxy credentials.

Обновить очередь This action is logged when the user updates the
existing queue (for example, adding new work
items to the same queue).

Не удалось обновить очередь This action is logged when the user fails to
update the existing queue (for example, adding
new work items to the same queue).

Обновить настройки This action is logged when the user updates any
setting in Control Room.

Update temporary devices auto delete settings This action is logged when the temporary device
updates its auto delete settings.

Обновить рабочий элемент This action is logged when the user edits a work
item.

Не удалось обновить рабочий элемент This action is logged when work items fail to
update.

UPDATE_DEVICE_ADVANCED_OPTIONS_SETTINGSThis action is logged when the user changes
the device environment settings such as: global
cache location, auto-login timeout duration, and
so on.
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Записи аудита Описание

UPDATE_DEVICE_THRESHOLD_SETTINGS This action is logged when the user changes
enables or disables the threshold settings such
as: CPU utilization, device memory threshold
values, and so on.

UPDATE_DEVICE_LOG_SETTINGS This action is logged when the user changes the
log collection settings such as: log collection, log
size, and so on.

UPDATE_GLOBAL_AUTO_LOGIN_SETTINGS This action is logged when the user changes
the auto-login settings in the Control Room to
either create user sessions, or reuse existing user
sessions to reduce the bot startup time.

Загрузить This action is logged when a user imports a file.

Обновить бот This action is logged when a user uploads a bot.

Загрузить документ This action is logged when a user uploads a
document.

Отправить файл This action is logged when a user uploads a file.

Загрузить пакет This action is logged when the user uploads a
package.

Загрузить файл рабочих элементов This action is logged when the user updates a
queue and adds work items.

User Authentication configuration This action is logged when the user changes
the Control Room database or SAML user
authentication configuration.

Многократный вход пользователя в систему This action is logged when the user logs in to
the Control Room from different browsers with
the same username.

Пользователь вошел This action is logged when the user logs in to
the Control Room.

Пользователь вышел This action is logged when the user logs out of
the Control Room.

Проверить экземпляр для обучения This action is logged when the user validates
(either corrects the document and saves it or
invalidates the document) a document in the
validator of a learning instance.

Настройки управления версиями This action is logged when the user updates any
version control settings.

Сбой подключения прокси-сервера Websocket This action is logged when the websocket proxy
connection fails.

AD audit entries

The following table shows the list of AD audit entries and their descriptions (listed alphabetically):
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Записи аудита Описание

Сопоставление групп AD создано This action is logged when the user creates an
AD role mapping.

Сопоставление групп AD удалено This action is logged when the user deletes an
AD role mapping.

Сопоставление групп AD обновлено This action is logged when the user updates an
Active Directory role mapping.

AD sync role empty This action is logged when an Active Directory
role assigned with sync operations is empty.

AD sync role conflict This action is logged when an Active Directory
role assigned with sync operations is in conflict
with another role.

Система функций AD Sync назначена This action is logged when new Active Directory
roles are assigned with sync operations.

Система функций AD Sync удалена This action is logged when Active Directory roles
are deleted with sync operations.

Система функций AD Sync обновлена This action is logged when Active Directory roles
are updated with sync operations.

AD sync user count This action is logged when the Active Directory
user counts are synced.

AD sync user deleted This action is logged when the Active Directory
synced users are deleted.

AD sync user out of license This action is logged when the Active Directory
synced users run out of available licenses.

Bot Insight audit entries

The following table shows the list of Bot Insight audit entries and their descriptions (listed alphabetically):

Записи аудита Описание

Bot Insight add user dashboard This action is logged when a new user dashboard
is added to Bot Insight.

Bot Insight BLM dashboard export This action is logged when a user exports a BLM
(Bot Lifecycle Management) dashboard from Bot
Insight.

Bot Insight BLM dashboard import This action is logged when a user imports a BLM
(Bot Lifecycle Management) dashboard into Bot
Insight.

Bot Insight create dashboard This action is logged when a user creates a
dashboard in Bot Insight.

Bot Insight copy dashboard This action is logged when a user copies a
dashboard in Bot Insight.

Bot Insight delete dashboard This action is logged when a user deletes a
dashboard from Bot Insight.
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Записи аудита Описание

Bot Insight delete user dashboard This action is logged when a user dashboard is
deleted from Bot Insight.

Bot Insight end task This action is logged when a task ends in Bot
Insight.

Bot Insight get task data This action is logged when task data is retrieved
in Bot Insight.

Bot Insight get user dashboards This action is logged when user dashboards are
retrieved in Bot Insight.

Bot Insight load dashboard This action is logged when a user loads a
dashboard in Bot Insight.

Bot Insight operations This action is logged when operations occur in
Bot Insight.

Bot Insight publish dashboard This action is logged when a user publishes a
dashboard in Bot Insight.

Bot Insight registers dashboard This action is logged when a user registers a
dashboard in Bot Insight.

Bot Insight run data This action is logged when data runs in Bot
Insight.

Bot Insight save dashboard This action is logged when a user saves a
dashboard in Bot Insight.

Bot Insight search dashboard This action is logged when a user searches a
dashboard in Bot Insight.

Bot Insight start task This action is logged when a task starts in Bot
Insight.

Bot Insight update dashboard This action is logged when a user updates a
dashboard in Bot Insight.

Bot Insight profile update This action is logged when a user updates a data
profile in Bot Insight.

Bot Store audit entries

The following table shows the list of Bot Store audit entries and their descriptions (listed alphabetically):

Записи аудита Описание

Bot Store add to My bots This action is logged when a user adds a bot to
their My bots.

Bot Store clean up This action is logged when clean up is performed
for a deleted tenant.

Bot Store download This action is logged when a user starts to
download a bot from the Bot Store.

Bot Store log in This action is logged when a user logs in to the
Bot Store.
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Записи аудита Описание

Bot Store submit bots This action is logged when a user submits bots to
the Bot Store.

Device pool audit entries

The following table shows the list of device pool audit entries and their descriptions (listed alphabetically):

Записи аудита Описание

Пул устройств создан This action is logged when the user successfully
creates a new device pool.

Не удалось создать пул устройств This action is logged when the user fails to create
a device pool.

Пул устройств удален This action is logged when the user successfully
deletes a device pool.

Не удалось удалить пул устройств This action is logged when the user fails to delete
a device pool.

Не удалось обновить пул устройств This action is logged when the user fails to
update an existing device pool.

Пул устройств обновлен This action is logged when the user edits an
existing device pool (for example, add a new
device or add a new customer role).

Device update audit entries

The following table shows the list of device update audit entries and their descriptions (listed
alphabetically):

Записи аудита Описание

Обновление устройства подтверждено This action is logged when the device update has
been acknowledged.

Обновление устройства уже в процессе
выполнения

This action is logged when the device update is
already in progress.

Обновление устройства завершено This action is logged when the device update has
completed.

Device update disconnected This action is logged when the device update has
been disconnected.

Обновление устройства скачано This action is logged when the device update has
been downloaded.

Device update failed and max retry reached This action is logged when the device update has
failed after the maxiumum number of retries has
been reached.
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Записи аудита Описание

Device update failed and max retry reset
reached

This action is logged when the device update
has failed but device will continue to retry the
update.

Обновление устройства инициировано This action is logged when the user initiates the
device update.

Device update settings This action is logged when the settings of a
device are updated.

Обновление устройства начато This action is logged when the device update has
started.

Device update unavailable This action is logged when the device update has
already occurred and been updated.

Обновление устройства не удалось This action is logged when the device update has
been unsuccessful.

Обновление устройства ожидает завершения
развертываний

This action is logged when the device update is
waiting for deployments to complete.

Discovery bot audit entries

The following table shows the list of Discovery bot audit entries and their descriptions (listed
alphabetically):

Записи аудита Описание

Discovery bot cancel recording This action is logged when the discovery bot
successfully cancels a recording.

Discovery bot convert to bot This action is logged when the discovery bot
successfully converts to a bot.

Discovery bot create aggregated recording This action is logged when the discovery bot
successfully creates a new aggregated recording.

Discovery bot create opportunity This action is logged when the discovery bot
successfully creates a new opportunity.

Discovery bot create process This action is logged when the discovery bot
successfully creates a new process.

Discovery bot create process assignment This action is logged when the discovery bot
successfully creates a new process assignment.

Discovery bot create project This action is logged when the discovery bot
successfully creates a new project.

Discovery bot create recording This action is logged when the discovery bot
successfully creates a new recording.

Discovery bot create recording step This action is logged when the discovery bot
successfully creates a new recording step.

Discovery bot create recording step metadata This action is logged when the discovery
bot successfully creates metadata for a new
recording step.
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Записи аудита Описание

Discovery bot delete aggregated recording This action is logged when the discovery bot
sucessfully deletes an aggregated recording.

Discovery bot delete opportunity This action is logged when the discovery bot
successfully deletes an opportunity.

Discovery bot delete process This action is logged when the discovery bot
successfully deletes a process.

Discovery bot delete process assignment This action is logged when the discovery bot
successfully deletes a process assignment.

Discovery bot delete project This action is logged when the discovery bot
successfully deletes a project.

Discovery bot delete recording This action is logged when the discovery bot
successfully deletes a recording.

Discovery bot delete recording step This action is logged when the discovery bot
successfully deletes a recording step.

Discovery bot delete recording step metadata This action is logged when the discovery bot
successfully deletes metadata for a recording
step.

Discovery bot export opportunity This action is logged when the discovery bot
exports an opportunity.

Discovery bot migrate opportunity This action is logged when the discovery bot
migrates an opportunity.

Discovery bot update aggregated recording This action is logged when the discovery bot
edits an existing aggregated recording.

Discovery bot update aggregated recording json This action is logged when the discovery bot
edits an existing aggregated recording using
json.

Discovery bot update opportunity This action is logged when the discovery bot
edits an existing opportunity.

Discovery bot update process This action is logged when the discovery bot
edits an existing process.

Discovery bot update process assignment This action is logged when the discovery bot
edits an existing process assignment.

Discovery bot update project This action is logged when the discovery bot
edits an existing project.

Discovery bot update recording This action is logged when the discovery bot
edits an existing recording.

Discovery bot update recording step This action is logged when the discovery bot
edits an existing recording step.

Discovery bot update recording step metadata This action is logged when the discovery bot
edits metadata for an existing recording step.
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Run bot audit entries

The following table shows the list of run bot audit entries and their descriptions (listed alphabetically):

Записи аудита Описание

Запуск бота отключен This action is logged when a user disconnects a
running bot.

Запуск бота завершен This action is logged when a running bot finishes.

Запуск бота приостановлен This action is logged when a user pauses a
running bot.

Run bot pre process failed This action is logged when the pre-process to run
the bot fails.

Запуск бота вновь подключен This action is logged when a user re-connects a
running bot.

Запуск бота возобновлен This action is logged when a previously paused
bot resumes to run.

Запуск бота остановлен This action is logged when a user stops a running
bot.

Run bot local audit entries

The following table shows the list of run bot local audit entries and their descriptions (listed alphabetically):

Записи аудита Описание

Run bot local hotkey finished This action is logged when a running bot for a
local hotkey finishes.

Run bot local hotkey paused This action is logged when a running bot for a
local hotkey pauses.

Run bot local hotkey resumed This action is logged when a running bot for a
local hotkey resumes.

Run bot local hotkey started This action is logged when a running bot for a
local hotkey starts.

Run bot local hotkey stopped This action is logged when a running bot for a
local hotkey stops.

Run bot local hotkey suspended This action is logged when a running bot for a
local hotkey is suspended.

Run bot local schedule finished This action is logged when a running bot for a
local schedule finishes.

Run bot local schedule paused This action is logged when a running bot for a
local schedule pauses.

Run bot local schedule resumed This action is logged when a running bot for a
local schedule resumes.
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Записи аудита Описание

Run bot local schedule started This action is logged when a running bot for a
local schedule starts.

Run bot local schedule stopped This action is logged when a running bot for a
local schedule stops.

Run bot local schedule suspended This action is logged when a running bot for a
local schedule is suspended.

Run bot local triggger finished This action is logged when a running bot for a
local triggger finishes.

Run bot local triggger paused This action is logged when a running bot for a
local triggger pauses.

Run bot local triggger resumed This action is logged when a running bot for a
local triggger resumes.

Run bot local triggger started This action is logged when a running bot for a
local triggger starts.

Run bot local triggger stopped This action is logged when a running bot for a
local triggger stops.

Run bot local triggger suspended This action is logged when a running bot for a
local triggger is suspended.

Run logic local audit entries

The following table shows the list of run logic local audit entries and their descriptions (listed
alphabetically):

Записи аудита Описание

Run logic local client finished This action is logged when running logic for a
local client finishes.

Run logic local client paused This action is logged when running logic for a
local client pauses.

Run logic local client resumed This action is logged when running logic for a
local client resumes.

Run logic local client started This action is logged when running logic for a
local client starts.

Run logic local client stopped This action is logged when running logic for a
local client stops.

Run logic local client suspended This action is logged when running logic for a
local client is suspended.

Run workflow local audit entries

The following table shows the list of run workflow local audit entries and their descriptions (listed
alphabetically):
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Записи аудита Описание

Run workflow local client finished This action is logged when running a workflow
for a local client finishes.

Run workflow local client started This action is logged when running a workflow
for a local client starts.

Run workflow local client stopped This action is logged when running a workflow
for a local client stops.

Run workflow local schedule finished This action is logged when running a workflow
for a local schedule finishes.

Run workflow local schedule started This action is logged when running a workflow
for a local schedule starts.

Run workflow local schedule stopped This action is logged when running a workflow
for a local schedule stops.

Run workflow local trigger finished This action is logged when running a workflow
for a local trigger finishes.

Run workflow local trigger started This action is logged when running a workflow
for a local trigger starts.

Run workflow local trigger stopped This action is logged when running a workflow
for a local trigger stops.

Schedule bot audit entries

The following table shows the list of schedule bot audit entries and their descriptions (listed
alphabetically):

Записи аудита Описание

Планирование бота отключено This action is logged when a scheduled bot is
disconnected.

Планирование бота окончено This action is logged when a scheduled bot ends.

Планирование бота приостановлено This action is logged when a scheduled bot
pauses.

Планирование бота вновь подключено This action is logged when a scheduled bot is
reconnected.

Планирование бота возобновлено This action is logged when a scheduled bot
resumes.

Планирование бота остановлено This action is logged when a scheduled bot stops.

Export audit data to CSV
Export Control Room log related data to a CSV file.
• You must have the View_user permission to export the basic information about other users to the CSV

file.
• The source and the target Control Room instances must be running the same version.
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• The source and the target Control Room instances must be of the same setup type: SSO with SSO, AD
with AD, and non-AD with non-AD.

You can export selected, filtered, or all audit log data to a CSV file by using the following options:
• Export checked items
• Export filtered items
• Export all items

1. Перейдите в раздел Администрирование > Журнал аудита.
A list of all the logs is displayed.

2. Click the Export items to CSV drop-down

menu.
3. Click one of the following required sub-menus:

• Export checked items: Exports only the selected records.

Прим.:  You must select items to use this option.

• Export filtered items: Exports only records that are available after applying filters like Status, Item
name, Event type, and so on.

• Export all items: Exports all the available records.

Прим.:  Одновременно можно экспортировать не более 100 000 записей.

The CSV file is exported and downloaded to your local system based on the selected option.

Прим.:
• If there is large number of audit logs to export, a message is displayed, informing that the

export function is started and exported CSV file is available in the Activity > Historical page.
Подробнее см. в разделе Download exported CSV file.

• Время, необходимое для экспорта данных в файл CSV, может варьироваться в зависимости от
количества экспортируемых записей. Если для экспорта данных потребуется более 2 секунд,
на экране появится сообщение. После создания файл CSV будет доступен для скачивания.

Также см. Syslog server integration.

Download exported CSV file
When there is large number of audit log data to export, the export function starts and exported CSV file is
available in the Activity > Historical page.
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To download the exported CSV file,
1. Navigate to the Activity > Historical page and search for exported audit log by using the Audit-

Export

keyword.
A list of all the exported audit log files is displayed.

2. Click the required item name hyperlink to view the audit log details.

3. Click Download exported zip file.

The CSV file is downloaded to your local system as a zip file.

Пользователи
As an administrator, you can create, view, edit, delete, and enable or disable a user. Creating users steps
vary depending on whether the user is a non-Active Directory, Active Directory, or single sign-on (SSO)
user from an IdP server.

Column actions

• Click a column header to sort by ascending or descending order.
• Drag and drop a column header to move the column left or right.
• Drag the end of a column corner to re-size.

Individual user actions

Perform the following tasks on an individual user:

Просмотреть Opens the View user page in read-only mode.
It shows user details, assigned roles, and general
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details such as Last Modified, Modified by,
Object type, and User type.
You can edit a user detail and enable or disable a
user.

Редактировать Opens the Edit user page in write mode. You
can update user details, device login credentials,
assigned roles, and device licenses.
When you edit a user, an email is sent notifying the
user if SMTP is enabled.
Only user devices with the Bot Agent installed at
the system level are available for selection as the
default device.

Enable︱Disable Activates or deactivates the user. When you enable
or disable a user, an email is sent notifying the user
if SMTP is enabled.

Удалить Deletes the user. This is useful when users leave
an organization or move to another role. This frees
both the device to which the user was attached and
the allocated license.
When you delete a user, an email is sent notifying
the user if SMTP is enabled.

Прим.:  Before removing a user from the active
RPA, administrators should make certain all
unfinished development of bots are checked-in.

Table-level actions

Perform the following tasks by hovering the mouse over the icons at the top-right of the User table. These
actions can be performed only at a table-level and not on individual items.

Create role with checked items Adds a role and assigns the selected users.
Create a user

Delete checked items Deletes the selected users. You cannot delete a
user who is currently logged in.

Экспортировать в CSV Exports the selected users in the table in CSV
format.

Обновить Refreshes the table and reflects the latest data.
Настроить столбцы Select the columns to show or hide in the table.

Create a user
Create a user and assign their specific license based role.
Ensure that you are logged in to the  as the administrator.
1. Перейдите в раздел Администрирование > Пользователи.
2. Щелкните Создать пользователя.
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3. Enter the required general details as follows:

Поле Значение

Включить пользователя Select for the user to be activated and log in
immediately.

Прим.:  If this option is not selected, user will
be in the inactive state and cannot log in.

Имя пользователя Введите уникальное имя пользователя.

Описание Введите описание пользователя.

Имя Enter the first name for the user.

Прим.:  The number of characters allowed in the
First name field is 50.

Фамилия Enter the last name for the user.

Прим.:  The number of characters allowed in the
Last name field is 50.

Пароль Enter and confirm a password for the user.
Ensure that the password follows all the
necessary password policies.

Эл. почта Введите и подтвердите адрес электронной
почты пользователя.
If SMTP is enabled, an email is sent to this
address to confirm the account. All important
Control Room notifications are sent to this email
address.

4. Select the required role from the list of Available roles.
5. Click the right arrow (→) to add your selection.
6. Select Allow to allow multiple sessions.

You must be Control Room administrator to set a user as a multi-login service user. It is possible to set
a user as a multi-login user either in the UI or API, however a user may only access multiple sessions
through the API.

7. Assign a device license to the user.

Прим.:  When you logged in as administrator, you cannot allocate any device license to the user and
None option is selected by default.

Лицензия Privilege

Нет The user can access the Control Room only.

Bot Creator- Development license Enables user to create and run боты. Auto login
is enabled by default.
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Лицензия Privilege

Unattended Bot Runner - Run-time license Пользователи с этой лицензией могут
выполнять все задачи автоматизации, которые
доступны пользователям с сопровождением.
Кроме того, эта лицензия может быть
использована для развертывания Control
Room, централизованного планирования и
развертывания на основе API.

Attended Bot Runner - Run-time license Users with this license can run боты on their
devices and use any event trigger associated with
their user account or role. However, these users
cannot schedule боты.

Непрофессиональный разработчик -
Development license

Пользователи с этой лицензией могут
создавать и запускать боты (включая боты с
триггерами) на своих устройствах.

The Bypass legal disclaimer option is automatically enabled to allow the user to run боты on a
device without having to manually acknowledge a disclaimer.
After you select a device license, the Device login credentials are enabled. If you have the Attest
device credentials permission, you can choose to attest the device credentials for this user to
bypass credential validation when you deploy боты. The Bot Runner user should have an unlocked
and active user session.

Прим.:  This works only if the auto login setting Reuse an existing session is selected in the
Control Room by the administrator.

8. Щелкните Создать пользователя.

Watch the following video on how to create a user in Automation 360:

Создание пользователя Active Directory
Добавьте пользователя Active Directory, выбрав домен AD, указав сведения об окружении AD и
назначив функцию и лицензию на устройство.
Ensure that you are logged in to the  as the administrator.

Прим.:  Before removing a user, administrators should make certain all unfinished development of bots
are checked-in.

1. Перейдите в раздел Администрирование > Пользователи.
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2. В разделе Общая информация введите указанную ниже информацию.
a) Включить пользователя. Выберите этот параметр, чтобы пользователь мог войти в

систему немедленно.
b) Домен Active Directory. Выберите имя Active Directory для пользователя.

В списке отображаются все домены, доступные в контроллере домена Active Directory.

Прим.:  Control Room Active Directory поддерживает многодоменную среду с одним лесом.

c) Имя пользователя. Щелкните ПРОВЕРИТЬ ИМЯ В ACTIVE DIRECTORY.
• Если имя пользователя присутствует в базе данных Active Directory, поля Имя,

Фамилия, Эл. почта и Подтверждение эл. почты заполняются автоматически.
Если данные не заполняются автоматически, введите данные в эти поля.

Прим.:  В имени пользователя можно использовать зарезервированные символы,
например запятую (,).

• Если имя пользователя отсутствует в базе данных Active Directory, отображается
сообщение об ошибке. Для решения проблемы обратитесь к сетевому администратору.

Если включен SMTP, пользователю на этот адрес отправляется сообщение электронной
почты для подтверждения учетной записи. На этот адрес электронной почты будут
отправляться все важные уведомления Control Room. Для ввода имен пользователей
электронной почты можно использовать символ «@».

Прим.:  Для поддержки единого входа через SAML имя участника-пользователя (например,
в Azure Active Directory) должно совпадать с соответствующим именем пользователя в
Control Room.

3. Select the required role from the list of Available roles.
4. Assign a device license to the user.

Прим.:  When you logged in as administrator, you cannot allocate any device license to the user and
None option is selected by default.

Лицензия Privilege

Нет The user can access the Control Room only.

Bot Creator- Development license Enables user to create and run боты. Auto login
is enabled by default.

Unattended Bot Runner - Run-time license Пользователи с этой лицензией могут
выполнять все задачи автоматизации, которые
доступны пользователям с сопровождением.
Кроме того, эта лицензия может быть
использована для развертывания Control
Room, централизованного планирования и
развертывания на основе API.

Attended Bot Runner - Run-time license Users with this license can run боты on their
devices and use any event trigger associated with
their user account or role. However, these users
cannot schedule боты.
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Лицензия Privilege

Непрофессиональный разработчик -
Development license

Пользователи с этой лицензией могут
создавать и запускать боты (включая боты с
триггерами) на своих устройствах.

The Bypass legal disclaimer option is automatically enabled to allow the user to run боты on a
device without having to manually acknowledge a disclaimer.
After you select a device license, the Device login credentials are enabled. If you have the Attest
device credentials permission, you can choose to attest the device credentials for this user to
bypass credential validation when you deploy боты. The Bot Runner user should have an unlocked
and active user session.

Прим.:  This works only if the auto login setting Reuse an existing session is selected in the
Control Room by the administrator.

5. Щелкните Создать пользователя.

Пользователь Непрофессиональный разработчик
A Непрофессиональный разработчик is a business user who can create and run боты, and share these
automated tasks with peers. Непрофессиональный разработчик is typically not a technical expert but a
specialist such as a marketing analyst, HR manager, and accounts manager.

Обзор

Users with бот creation capability can create, edit, run, or schedule боты on their device. While
users with бот execution capability can access a public folder to run or schedule published боты.
Непрофессиональный разработчик users combine these capabilities to create боты, access the public
folder, and clone published боты and run them on their devices.

Capabilities

In an organization, an administrator typically creates the Непрофессиональный разработчик role with the
necessary бот permissions and specifies the database or folder access. The administrator assigns this role
to existing or new users and allocates the Непрофессиональный разработчик license to them.
A Непрофессиональный разработчик user can then perform the following tasks:
• Create боты and run them on their devices.
• Add and delete event triggers for боты on their devices.

Citizen developer user can create a private event trigger. However, the associated бот must be checked
in to a public folder for other citizen developer or Bot Runner users to access that event trigger.

• Publish their боты to the public folder where other Непрофессиональный разработчик users can
access them.

• Access the public folder and clone published боты (including боты with triggers).
• Customize cloned боты and run them on their devices.
• Check in боты from their devices to the public folder.
• Check out боты from the public folder.

The following image illustrates the capabilities of a Непрофессиональный разработчик user:
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Пример

Consider a scenario where an organization has Marketing and Finance teams. The administrator creates
the following two Непрофессиональный разработчик roles:
• CD (Marketing): provides access to all Marketing team folders
• CD (Finance): provides access to all Finance team folders

The administrator then assigns the Непрофессиональный разработчик license to users within each
team. Непрофессиональный разработчик users with the CD (Marketing) role can create and run боты
on their devices. When a user with the CD (Marketing) role publishes a бот to a public folder, other
Непрофессиональный разработчик users within the Marketing team can clone and run this бот on their
devices.
Similarly, Непрофессиональный разработчик users with the CD (Finance) role will have the same
capabilities within the Finance team folders. However, users from one team cannot access any folders and
published боты from the other team.
Задачи, связанные с данной
Create a Непрофессиональный разработчик user
A Непрофессиональный разработчик is a business user who can build and run боты on their devices,
which then function as their digital assistants.
Create a Непрофессиональный разработчик role
A Непрофессиональный разработчик role enables the associated users to create and run боты on their
registered devices.
Adding event triggers
Any бот with triggers can be associated with users or role to enable event trigger. Control Room user (or
role) with Manage event triggers permission can add event triggers.
Ссылки, связанные с данной
Лицензии Automation 360
На странице Все лицензии отображается подробная информация о текущих лицензиях продукта и
устройства.

Create a Непрофессиональный разработчик user
A Непрофессиональный разработчик is a business user who can build and run боты on their devices,
which then function as their digital assistants.
Ensure that you are logged in to the  as the administrator.
1. Перейдите в раздел Администрирование > Пользователи.
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2. Щелкните Создать пользователя.
3. Enter the following user details:

a) Select the Enable User option if you want the user to be able to log in immediately.
b) Введите уникальное имя пользователя.
c) Необязательно: Введите описание пользователя.
d) Необязательно: Enter the first name and last name.

Прим.:  The number of characters allowed for the first and last name is 50.

e) Enter and confirm a password for the user.
Ensure the password follows any necessary password policy.

f) Введите и подтвердите адрес электронной почты пользователя.
Если включен SMTP, пользователю на этот адрес отправляется сообщение электронной
почты для подтверждения учетной записи. All Control Room notifications will be sent to this
email address.

4. Select a Непрофессиональный разработчик role from the list of Available roles.
If there is no Непрофессиональный разработчик role available, create one in Control Room.
Create a Непрофессиональный разработчик role

5. Click the right arrow (→) to add your selection.
6. Assign the Непрофессиональный разработчик license to the user.

The license enables users access to the Control Room only and enables them to create and run боты.
The Bypass legal disclaimer option is automatically enabled to allow the user to run боты on a
device without having to manually acknowledge a disclaimer.

7. Щелкните Создать пользователя.

Пользователь с несколькими именами для входа
Пользователь с несколькими именами для входа может выполнить вход в несколько сеансов Control
Room одновременно через API.
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Прим.:  Запрещено использовать несколько сеансов при доступе к Control Room через
пользовательский интерфейс.

Токены с несколькими именами для входа требуются, если вы хотите настроить для пользователя
Control Room одновременное использование различных процессов с помощью генерации токенов с
несколькими именами для входа, используя API. Вам необходима роль администратора Control Room,
чтобы установить пользователя в качестве пользователя службы с несколькими именами для входа.
Можно установить пользователя как пользователя службы с несколькими именами для входа как в
пользовательском интерфейсе, так и через API.
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Авторизация с помощью пользовательского
интерфейса

Авторизация с помощью API

В Control Room перейдите в раздел
Администрирование > Пользователи и
выберите Разрешить в разделе Разрешить
несколько сеансов, чтобы разрешить вход с
несколькими именами.

Using the Authentication API
Запрос

POST http://{{ControlRoomURL}}/v1/
authentication

Тело запроса для генерации токена с
несколькими именами для входа:

{
   "username":"jdoe",
   "password":"mypassword@123",
   "multipleLogin":true
}

Reset user password
The Control Room administrator generates an email process for the user to reset their password.
Ensure that you are logged in to the  as the administrator.
The change password email process.
1. Перейдите в раздел Администрирование > Пользователи.
2. Select user from the list.
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3. Click the Edit icon. ( )
4. Select Send reset password email.

Прим.:  If there is no email server configured, follow these steps to reset the password for a user:
a. Open the URL for the Control Room in your browser.
b. Enter the user name, click Forgot Password, and follow the prompts to reset or change the

password.
c. Enter the user name, click the Forgot Password button, and follow the prompts to reset or change

the password.

The selected user receives an email with the necessary instructions to reset the password.

Задачи, связанные с данной
Вход в Automation Anywhere Control Room
Чтобы войти в Automation 360, откройте URL-адрес Control Room в браузере, введите свои учетные
данные на экране входа и нажмите кнопку Вход.

Функции
The Control Room enforces role-based access control. There are two types of roles: system and user-
created.
Role-based access control (RBAC) gives users access to specific features, based on the assigned roles and
the accessibility provided to the user. The benefits of creating roles include:
• Increased security through controlling users access according to their specified roles.
• Decreased need of customer support.
• Easy and accurate monitoring of the use and access of data by higher management, leading to better

research management.

System roles These roles are preconfigured with the permissions
necessary to perform the tasks within the scope of
that role. They cannot be modified or deleted.
System roles

User-created roles Users create these roles and the roles can be
customized. If a user-created role is created with
all Control Room permissions, it is not considered
a Control Room Admin role. Only the system-
created AAE_Администрирование role has this
privilege.
Create a role

Before removing a user role from the active RPA, administrators should make certain all unfinished
development of боты are checked-in.

Create a role
As an administrator, you can configure roles with permissions to access features and perform operations
such as create, edit, or delete a бот in the Control Room, and assign the role to a user.
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Ensure that you are logged in to the  as the administrator.
Assign specific permissions to each user. You cannot select users, if these users are deactivated by the
Control Room administrator.
1. Navigate to Administration > Roles.
2. Click Create role.
3. Введите Имя.
4. Необязательно: Введите описание.
5. Select the feature permissions.

For more information about the available feature permissions by product, see Разрешения на
использование для функции.

6. Щелкните Вперед.
7. Based on the option you select, perform the required action:

Вариант Действие

View my боты permission Select the боты permissions.

Бот permissions for a role

Run my боты permission Select the Bot Runner devices.

Просмотреть действия каждого
пользователя из моих папок.

Просмотреть действия бот, которые начаты
другими пользователями, из папок, где
данный пользователь имеет разрешения на
выполнение и/или планирование.

Управлять действиями каждого
пользователя из моих папок.

Управлять действиями бот, например
Приостановить, Возобновить и
Остановить, которые начаты разными
пользователями из папок, где у вас
есть разрешения на выполнение и/или
планирование.

8. Щелкните Вперед.
9. Select user from the list.
10. Click Create role.

Понятия, связанные с данным
Бот permissions for a role
Assign бот permissions when creating a role with the View my боты feature permission.
Ссылки, связанные с данной
System roles
System roles are preconfigured with the permissions necessary to perform the tasks within the scope of
that role. They cannot be modified or deleted. Administrators assign the roles to users to enable them to
access features and perform operations in the Control Room.

Разрешения на использование для функции
Пользователь с функцией AAE_Admin или пользовательской функцией с разрешением
Управление функциями может создавать и назначать функции пользователям для
предоставления им доступа к функциям и операциям.
Мы рекомендуем создавать отдельные функции с определенными разрешениями. Затем вы можете
назначить ограниченные функции пользователям с определенными требованиями к разрешениям.
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Automation Anywhere Robotic Interface (AARI)

Разрешение Описание

Чтение между
рабочими группами

Просмотр всех групп и просмотр участников группы

Чтение между
процессами

Просмотр всех процессов и просмотр участников группы и
менеджеров

Управление рабочими
группами

Создание и просмотр групп, редактирование имен групп, описаний
и тегов процессов. Добавление новых групп, участников групп и
назначенных процессов

Управление задачами Отправка и просмотр задач из процессов, назначенных группе

Управление
обращениями

Создание и просмотр запросов из процессов, назначенных группе

Управление
глобальными
обращениями

Просмотр запросов и задач процесса.

Прим.:  Это разрешение не дает возможности создавать запрос или
отправлять задачу

Управление
глобальными
процессами

Просмотр зарегистрированных общих процессов и назначенных
менеджеров и групп, редактирование тегов процессов и назначение
менеджеров и групп

Прим.:  Это разрешение не дает возможности создать процесс.

Управление
глобальными рабочими
группами

Просмотр групп и назначенных пользователей, редактирование
названий и описаний групп. Добавление новых процессов,
менеджеров и пользователей в группу

Прим.:  Это разрешение не дает возможности создавать группу.

API

Разрешение Описание

Bot Insight Data API Предоставляет API-интерфейсам Bot Insight
RESTful доступ к данным, зарегистрированным в
Control Room и в рамках задачи во время запуска
«Производства».
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Разрешение Описание

Создать API-ключ Пользователи могут генерировать apiKey,
который может быть использован в
API-интерфейсе аутентификации.

Прим.:  Пользователи без разрешения
generateapikey могут использовать
API-интерфейсы, пройдя аутентификацию с
помощью своих имени пользователя и пароля.
Authentication API

Действия

Разрешение Описание

Просмотреть мои выполняемые действия Разрешает пользователям просматривать
собственные действия.

Прим.:  У всех функций есть это разрешение
по умолчанию.

Управлять моими выполняемыми действиями Разрешает пользователям приостанавливать,
возобновлять, отменять свои действия и
переносить свои завершенные действия в
историю.

Просмотреть выполняемые всеми действия Разрешает пользователям отслеживать
текущие автоматизации, в которых они
предоставляют или планируют предоставить
доступ к соответствующему бот.

Управлять выполняемыми всеми действиями Разрешает пользователям приостанавливать,
возобновлять, отменять свои действия и
переносить свои завершенные действия в
историю.

Просмотреть мои запланированные боты Allows users to view their own schedules only.

Планирование запуска моих боты Разрешает пользователям запланировать
запуск своих боты. Кроме того,
пользователям требуется разрешение на
просмотр и управление Bot Runner.

Редактировать мои запланированные
действия

Allows users to edit their own schedules only.

Удалить мои запланированные действия Allows users to delete their own schedules only.

Просмотреть и управлять ВСЕМИ
запланированными действиями из моих папок

Allows users to view, edit, and delete all the
schedules on the бот folders to which they have
access. It includes their own schedules and
schedules created by other users too.
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Разрешение Описание

Просмотреть и управлять ВСЕМИ
запланированными действиями

Разрешает пользователям просматривать,
редактировать и удалять все расписания
в системе. Сюда относятся расписания,
созданные пользователем, а также созданные
другими пользователями.

Установите высокий приоритет автоматизации Разрешает пользователям устанавливать
высокий приоритет автоматизации
для запуска и создания расписания
боты. Автоматизации с высоким
приоритетом отдается предпочтение перед
автоматизациями со средним и низким
приоритетом, чтобы вы могли запускать
и создавать расписание автоматизаций с
высоким приоритетом.

Журнал аудита

Разрешение Описание

Просмотреть все операции в журнале
аудита

Allows users to view all audit log activity for the Control
Room.

Боты

Разрешение Описание

Просмотреть мои боты Разрешает пользователям просматривать
боты, которые они создали, и боты, которые
им назначены.

Прим.:  Это разрешение необходимо
назначить перед назначением любых других
разрешений для боты.

Запустить мои боты Разрешает пользователям запускать боты,
которые они создали, и боты, которые им
назначены.

Экспортировать боты Разрешает пользователям экспортировать
боты и связанные зависимости бот, для
которых у них есть разрешение на загрузку.

Импорт боты Разрешает пользователям импортировать
боты и зависимости бот, для которых у них
есть разрешение на отправку.
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Разрешение Описание

Пометить боты Позволяет пользователям создавать метки
для определенной версии бот. Эти метки
позволяют пользователям планировать,
запускать, ставить в очередь, экспортировать
и выполнять рабочие процессы разработки
бот с выбранной ими версией.

Прим.:  The Set production version
permission is redundant in Automation 360
although it might be displayed when you migrate
боты from Enterprise 11. The Label bots
permission is the equivalent of Set production
version in Automation 360.
If you want to select the Export bots option,
you must select the Set production version
permission in such cases. Also, if you want to
provide the ability to set production version, you
must select the Label bots permission.

Создать папки Разрешает пользователям создавать папки в
папках, к которым у них есть доступ.

Переименовать папки Разрешает пользователям переименовывать
папки, к которым у них есть доступ.

Прим.:  Переименовать можно только пустые
папки.

Отменить извлечение Разрешает пользователям отменить
извлечение бот и разблокировать файл из
общего репозитория.

Bot Store

Разрешение Описание

Просмотреть Bot Store Разрешает пользователям просматривать Bot
Store.

Добавить боты из Bot Store к моим Боты Разрешает пользователям добавлять пакеты
бот из Bot Store в свое личное рабочее
пространство Control Room.

Отправить боты в Bot Store Разрешает пользователям отправлять пакеты
бот в Bot Store.
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Учетные данные и ячейки

Разрешение Описание

Управление моими ячейки Разрешает пользователям создавать и
управлять собственными ячейки.

Создать стандартные атрибуты для учетных
данных

Allows users to create a standard attribute for a
credential that is shared across all users of that
credential.

Просмотреть и редактировать ВСЕ значения
атрибута учетных данных

Разрешает пользователям просматривать и
редактировать собственные замаскированные
атрибуты.

Прим.:  Вам не будет разрешено
редактировать атрибуты учетных данных
других пользователей.

Бот Auto-Login Credentials API Разрешает пользователям автоматизировать
процесс входа в систему для удаленного
запуска боты.

Прим.:  Пользователь с функцией AAE_Locker Admin может просматривать все учетные данные и
ячейки в Control Room. См. раздел System roles.

Информационные панели

Разрешение Описание

Просмотреть информационные панели Разрешает пользователям просматривать
информационную панель.

Прим.:  У всех функций есть это разрешение
по умолчанию.

Устройства

Разрешение Описание

«Зарегистрировать устройство» Разрешает пользователям регистрировать
локальное хост-устройство. Устройства

Просмотреть и управлять ВСЕМИ
устройствами

Разрешает пользователям просматривать
и управлять всеми устройствами в Control
Room.
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Разрешение Описание

Подтвердить учетные данные устройства Разрешает пользователям подтверждать
учетные данные устройства для
пользователей Bot Runner. Вы можете
развернуть боты на пользовательских
устройствах с разблокированным и активным
сеансом пользователя без системного пароля,
чтобы обойти проверку учетных данных.

Прим.:  Это разрешение работает
только в том случае, если параметр
автоматического входа Повторно
использовать существующий сеанс
выбран администратором в Control Room.

Удалить устройства Разрешает пользователям редактировать
устройства, которые им разрешено
просматривать.

Редактировать устройства Разрешает пользователям редактировать
устройства, которые им разрешено
просматривать.
Allows you to view and manage all (registered
and non-registered) devices from a specific
accessible group.

Прим.:  To view and manage registered and
non-registered devices,
• The Control Room administrator must grant

access to manage a specific set of devices.
• You must select Devices from my device

pool(s) to edit devices from device pools and
Run as user(s) default device to edit Run
as user(s) default device options in the Edit
devices permission.

Просмотреть и управлять моими Bot Creator,
Bot Runner и группами устройств

Разрешает пользователям просмотр и
управление Bot Creator, Bot Runner и
группами устройств.

Прим.:  У всех функций есть это разрешение
по умолчанию.

Create device pools Разрешает пользователям создавать и
управлять собственными группами устройств.

Прим.:  Пользователь с функцией AAE_Pool Admin может всеми группами устройств в Control
Room. См. раздел System roles.
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Discovery Bot процесс

Разрешение Описание

Просмотреть назначенный процесс Разрешает пользователям просматривать
назначенные процессы.

Прим.:  Это стандартное разрешение. Это
разрешение необходимо назначить перед
назначением любых других разрешений на
обнаружение процессов.

Просмотреть все процессы Разрешает пользователям просматривать все
определенные процессы.

Редактировать процесс Разрешает пользователям создавать и
редактировать процессы.

Запись Discovery Bot

Разрешение Описание

Просмотреть все записи Разрешает пользователям просматривать все записи.

Просмотреть собственную запись Разрешает пользователям просматривать собственную
запись.

Прим.:  Это разрешение необходимо назначить перед
назначением любого из перечисленных ниже разрешения.

Запустить средство записи и
создать запись

Разрешает пользователям запускать средство записи и
создавать запись.

Редактировать собственную
запись

Разрешает пользователям редактировать собственную
запись.

Удалить собственную запись Разрешает пользователям удалять собственную запись.

Агрегирование Discovery Bot

Разрешение Описание

Просмотреть все агрегирования Разрешает пользователям просматривать все
агрегирования.

Просмотреть собственное агрегирование Разрешает пользователям просматривать
собственные агрегирования.

Прим.:  Это разрешение необходимо назначить
перед назначением любого из перечисленных ниже
разрешений.
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Разрешение Описание

Создать или удалить собственное
агрегирование

Разрешает пользователям создавать и удалять
агрегирования.

Редактировать агрегирование Разрешает пользователям обновлять
агрегирования.

Просмотреть агрегирование, созданное
системой

Разрешает пользователям просматривать
системные агрегирования.

Возможности Discovery Bot

Разрешение Описание

Просмотреть все возможности Разрешает пользователям просматривать все
возможности.

Просмотреть возможности Разрешает пользователям просматривать
возможности в пределах назначенного
процесса.

Прим.:  Это разрешение необходимо
назначить перед назначением любого из
перечисленных ниже разрешений.

Создать или удалить возможность Разрешает пользователям создавать
и удалять возможности в пределах
назначенного процесса.

Преобразование в бот Разрешает пользователям выполнять
преобразование возможности в бот.

Экспортировать возможность Разрешает пользователям экспортировать
возможность.

Триггеры события

Разрешение Описание

Просмотреть триггеры событий Разрешает пользователям просматривать
триггеры событий.

Управлять триггерами событий Разрешает пользователям просматривать и
управлять триггерами событий.

Прим.:  Необходимо назначить разрешение
view перед назначением этого разрешения.
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IQ Bot

Разрешение Описание

Просмотреть IQ Bot Разрешает пользователям просматривать
информационные панели по умолчанию в портале IQ
Bot.

Прим.:  Это разрешение необходимо назначить
перед назначением любого из разрешений IQ Bot.

Разрешения на администрирование IQ Bot

Идентификатор разрешения Описание

Просмотреть
администрирование

Разрешает пользователям получать доступ к вкладке
Администрирование на портале IQ Bot.

Прим.:  Это разрешение необходимо назначить
перед назначением любых других разрешений на
администрирование.

Просмотреть и управлять
настройками

Разрешает пользователям управлять расширенными
настройками конфигурации портала IQ Bot.

Просмотреть и управлять
миграцией

Разрешает пользователям получать доступ к утилите
миграции для импорта и экспорта обучаемых экземпляров на
портале IQ Bot.

Разрешения для доменов IQ Bot

Разрешение Описание

Просмотреть домены Разрешает пользователям просматривать все домены на портале IQ
Bot.

Прим.:  Это разрешение необходимо назначить перед назначением
любых других разрешений для доменов.

Создать домены Разрешает пользователям создавать домены на портале IQ Bot.

Импортировать
домены

Разрешает пользователям импортировать домены на портале IQ Bot.

Экспортировать
домены

Разрешает пользователям экспортировать домены на портале IQ Bot.
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Разрешения для обучаемых экземпляров IQ Bot

Разрешение Описание

Просмотреть обучаемые экземпляры Разрешает пользователям просматривать свои
обучаемые экземпляры на портале IQ Bot.

Прим.:  Это разрешение необходимо
назначить перед назначением любого другого
разрешения для обучаемого экземпляра.

Просмотреть обучаемые экземпляры из одной
функции

Разрешает пользователям просматривать
обучаемые экземпляры, созданные другими
пользователями с той же функцией, на
портале IQ Bot.

Просмотреть ВСЁ обучение на примерах Разрешает пользователям просматривать все
обучаемые экземпляры на портале IQ Bot.

Запустить проверяющий элемент управления Разрешает пользователям получать доступ
к валидатору IQ Bot для просмотра и
обновления документов с исключениями.

Создать обучение на примерах Разрешает пользователям создавать
обучаемые экземпляры на портале IQ Bot.

Редактировать обучение на примерах Разрешает пользователям редактировать
обучаемые экземпляры на портале IQ Bot.

Удалить обучение на примерах Разрешает пользователям удалять свои
обучаемые экземпляры на портале IQ Bot.

Отправить обучение на примерах в работу Разрешает пользователям отправлять свои
обучаемые экземпляры в производство на
портале IQ Bot.

Тренинг групп обучения на примерах Разрешает пользователям обучать свои
группы обучаемых экземпляров на портале IQ
Bot.

Менеджер Пакет

Разрешение Описание

Просмотреть пакеты Разрешает пользователям просматривать
пакеты.

Управлять пакеты Разрешает пользователям просматривать
пакеты и управлять ими.
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Лицензии

Разрешение Описание

Просмотреть лицензии Разрешает пользователям просматривать
сведения о лицензии для Control Room.

Управление лицензиями на устройство
пользователя

Разрешает пользователям назначать
лицензии на устройства другим
пользователям.

Установить лицензии Разрешает пользователям устанавливать
лицензии Automation 360 для Control Room.

Политики

Разрешение Описание

Просмотреть политики Разрешает пользователям просматривать политики, которые
определяют, как можно создавать автоматизации.

Управлять политиками Разрешает пользователям просматривать и управлять политиками,
которые определяют, как можно создавать автоматизации.

Миграция

Разрешение Описание

Просмотр миграции Allows users to view new migrations, but not run
them.

Прим.:  You must assign this permission before
assigning the manage migration permission.

Управлять миграцией Allows users to view and run new migrations.

Разрешить пользователю Bot Runner
запускать миграции

Allows Bot Runner user to update the бот
conversion status in the Control Room.

Настройки

Прим.:  Только пользователь с функцией AAE_Admin имеет возможность просматривать настройки
и управлять ими в Control Room. См. раздел System roles.
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Пользователи и функции

Разрешение Описание

Просмотреть пользователей Разрешает пользователям только просматривать всех
остальных пользователей в системе. Они не могут
создавать, редактировать или удалять пользователей.

Прим.:  Это разрешение необходимо назначить перед
назначением разрешений Create user Update user
или Delete user.

Удалить пользователей Разрешает пользователям удалять других
пользователей Control Room.

Создать пользователей Разрешает пользователям создавать новых
пользователей в Control Room.

Редактировать пользователей Разрешает пользователям редактировать всех
пользователей в системе.

Просмотреть функции Пользователи с этим разрешением могут
просматривать функции в Control Room.

Прим.:  Это разрешение необходимо назначить перед
назначением разрешения Manage roles.

Управлять функциями Разрешает пользователям просматривать и управлять
всеми функциями в Control Room.

Просмотреть основную информацию
о пользователях и функциях

Разрешает пользователям просматривать основную
информацию о пользователях и функциях в Control
Room.

Workload Management (WLM)

Разрешение Описание

Просмотреть и управлять моими
очередями

Allows users to view and manage their own queues.

Запланировать запуск ботов Allows a user to run a бот with queue

View and manage all activities from
my folders

Allows users to pause, resume, and stop all the WLM
automations on the бот folders which they have access to.

View and manage all activities Allows users to pause, resume, and stop all the WLM
automations.

Создать очереди Разрешает пользователям создавать собственные
очереди и управлять ими.
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Разрешение Описание

Калькулятор SLA… Разрешает пользователям рассчитывать соглашения об
уровне обслуживания (SLA) для рабочих нагрузок.

Прим.:  This permission is not in use.

Прим.:  Пользователь с функцией AAE_Queue Admin имеет все разрешения на рабочие нагрузки.
Кроме того, AAE_Queue Admin может управлять всеми очередями в Control Room. См. раздел System
roles.

Разрешения Update Bot wizard

Вы можете назначить разрешения функций для доступа и преобразования бот из Internet Explorer в
Microsoft Edge в IE с помощью Update Bot wizard. Эти разрешения можно назначить на странице
Администрирование > Функции > Создать или редактировать функцию.

Разрешение Описание

Просмотреть обновление бот Разрешает пользователю просматривать
статус и сводные сведения каждого
экземпляра обновления бот, когда
боты преобразуются на странице
Администрирование > Update Bot wizard.
Однако пользователь не может запускать
обновления. Для этого пользователю
необходимо разрешение Управлять
обновлением ботов.

Управлять обновлением бот Разрешает пользователю запускать новые
обновления бот с помощью Update Bot wizard.

Разрешить пользователю Bot Runner
обновлять боты

Разрешает пользователям Bot Runner
отправлять статус обновления бот обратно
в Control Room так, чтобы он был виден в
отчете Update Bot wizard.
Это разрешение по умолчанию назначается
пользователю с функцией AAE_Admin.

Бот permissions for a role
Assign бот permissions when creating a role with the View my боты feature permission.

Разрешение Описание

Выбрать все Enables users to check in, check out, view, delete, run, and schedule боты.

Run/Schedule/Run
and Schedule

Enables users to run and schedule боты when the role has the Run my bots and
Schedule my bots to run feature permissions.

Прим.:
• This permission is limited to running боты when the role has only the Run my

bots feature permission.
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Разрешение Описание
• This permission is limited to scheduling боты when the user has only the

Schedule my bots to run feature permission.

Загрузить… Enables users to check in бот files or folders to the public workspace from their
private workspace. When this permission is selected, the Clone and View content
permissions are automatically enabled. These permissions can only be disabled by
an user with the AAE_Администрирование role .

Выгрузить… Enables users to check out бот files or folders from the public workspace. It creates
an editable copy of the бот in the private workspace. A бот can be checked out by
one user at a time. When this permission is selected, the Clone and View content
permissions are automatically enabled. These permissions cannot be disabled.

Прим.:  To check out dependent folders and files, you must have the Check out
permission on the dependency folders.

Смотреть
содержимое

Enables users to view the contents of a бот. This permission applies to both the
public and private workspaces. To create a copy of the cloned бот or file in the
private workspace, you must have the View content permission on the same
folder in the public workspace.

Прим.:  You must have the View content permission enabled to export a бот and
its dependencies.

Клонировать… Enables users to create a read-only copy of the бот from the public workspace
to their private workspace. A бот can be cloned by multiple users. The Clone
permission must be assigned at the folder level for the бот in the public workspace.
To clone a dependency folder, you must have the Clone permission on the
dependency folder.

Прим.:
• If you have cloned a бот and the corresponding public folder is deleted, then

there will be no classifications on the cloned бот in your private workspace.
Copy, view, or delete permissions will be available at the бот level.

• You cannot move or rename a cloned бот in your private workspace. You must
have the View content permission on the same folder in the public workspace
to view the contents of your cloned бот in the private workspace.

Удалить Enables users to remove files and their dependencies from the public workspace.

Задачи, связанные с данной
Create a role
As an administrator, you can configure roles with permissions to access features and perform operations
such as create, edit, or delete a бот in the Control Room, and assign the role to a user.

Create a Непрофессиональный разработчик role
A Непрофессиональный разработчик role enables the associated users to create and run боты on their
registered devices.
Ensure that you are logged in to the  as the administrator.
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Although you can create a Непрофессиональный разработчик role and assign additional custom бот
permissions, ensure the role has all the feature permissions mentioned in this procedure.
1. Navigate to Administration > Roles.
2. Click Create role.
3. Введите Имя.
4. Необязательно: Введите описание.
5. Select the following feature permissions:

• Триггеры события
Select the View and manage my event triggers option to allow the user to view, run trigger-
based automation, or delete event triggers.

Прим.:  The View and Manage my event triggers option is specific to the
Непрофессиональный разработчик license and can fail if it is assigned to users with Bot Creator
or other licenses. Adding trigger events from the private repository is not supported.

• Боты
Select the View my bots option and the following permissions:
• Run my bots
• Import bots
• Cancel checkout

• Устройства
Select the following permissions:
• Register device
• View and manage ALL device(s)
• Edit the device(s)

6. Щелкните Вперед.
7. Click Create role.

A Непрофессиональный разработчик role is created in the Control Room. You can create a
Непрофессиональный разработчик user and assign this role to that user.
Create a Непрофессиональный разработчик user

Assign a role
Roles grant specific permissions to users, such as Bot Creator and Bot Runner.
Ensure that you are logged in to the  as the administrator.
Assign specific permissions to each user. You cannot select users, if these users are deactivated by the
Control Room administrator.
1. Navigate to Administration > Roles.
2. Click Create role.
3. Введите Имя.
4. Необязательно: Введите описание.
5. Set the required permissions for the role associated with this repository.
6. Щелкните Боты.
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7. Select the desired repository folder and grant associating permissions.
Вариант Действие

Выбрать все Grant all associated permissions for the
repository.

Запустить Permission to run боты from the repository.

Загрузить… Permission to import боты to the repository.

Выгрузить… Permission to export the бот from of the
repository.

Удалить из общедоступных Permission to permanently remove боты from the
Public repository.

8. Необязательно: Click RUN AS.
This is where administrators select the specific device this role will have access to.

9. Click Create role.

Assign this role to the appropriate Bot Creator users.

System roles
System roles are preconfigured with the permissions necessary to perform the tasks within the scope of
that role. They cannot be modified or deleted. Administrators assign the roles to users to enable them to
access features and perform operations in the Control Room.
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Automation 360 функций

Функция Разрешения

AAE_Администрирование
This role allows access to all features,
enables users to create other Admin
users, and access to all folders and
files in the public workspace, including
permissions to Create/Edit/Delete
Global Values. This is the only role that
can access Control Room settings.

Информационная
панель

Просмотреть
информационные панели

Действия • View and manage my in-
progress activity

• View and manage
everyone's in-progress
activity

• Просмотреть мои
запланированные боты

• Планирование запуска
моих боты

• Редактировать мои
запланированные
действия

• Удалить мои
запланированные
действия

• Просмотреть и
управлять всеми
запланированными
действиями из моих
папок

• View and manage all
scheduled activity

Event Triggers View and manage event
triggers

Боты • View and run my боты
• Import and export my

боты
• Создание и

переименование папок
• Manage my credentials

and lockers
• Создать стандартные

атрибуты для учетных
данных

• Бот Auto-Login
credential API

Package Manager View and manage пакеты
Устройства • «Зарегистрировать

устройство»
• View and manage all

devices
• View and manage my

Bot Runner, Bot Creator,
and device pools

Рабочая нагрузка • Просмотреть и
управлять моими
очередями

• Администрировать все
очереди

• Калькулятор SLA

Bot Store • Просмотреть Bot Store
• Submit боты to Bot

Store

Audit Log View all audit log actions
Администрирование • View and manage users

• View and manage roles
• Просмотреть и

управлять настройками
• Просмотреть и

управлять миграцией
• View, manage, and

install licenses

API Bot Insight Data API

AAE_Основы
This role provides permissions to
upload and download TaskBots in the
My Tasks folder. Limited access to
other features.

Информационная
панель

Просмотреть
информационные панели

Действия View my in-progress activity
Боты • View and run my боты

• Manage my credentials
and lockers

• Создать стандартные
атрибуты для учетных
данных

Package Manager Просмотреть пакеты
Устройства • «Зарегистрировать

устройство»
• View and manage my

Bot Runner, Bot Creator,
and device pools

Рабочая нагрузка Просмотреть и управлять
моими очередями

Bot Store Просмотреть Bot Store
Администрирование View basic information

about users and roles

AAE_Разработчик ботов
This role allows users to download
боты or пакеты from Bot Store to the
Control Room private workspace.

Прим.:  This role does not grant
permission to register a device, or
check боты in or out of the public
workspace.

Информационная
панель

Просмотреть
информационные панели

Действия View my in-progress activity
Боты • View and run my боты

• Импорт боты
• Создать папки
• Manage my credentials

and lockers
• Создать стандартные

атрибуты для учетных
данных

Package Manager View and manage пакеты
Устройства View and manage my Bot

Runner, Bot Creator, and
device pools

Рабочая нагрузка Просмотреть и управлять
моими очередями

Bot Store View and download боты
from Bot Store

Администрирование View basic information
about users and roles

AAE_Администратор ячейки
Can view all credentials and all lockers.
Позволяет пользователям с этой
функцией изменять владельцев
учетных данных, которые этим
пользователям не принадлежат.
For lockers they do not own, they can
delete the locker, edit permissions, and
remove credentials.

Информационная
панель

Просмотреть
информационные панели

Действия View my in-progress activity
Боты • Manage my credentials

and lockers
• Administer all lockers
• Создать стандартные

атрибуты для учетных
данных

Устройства View and manage my Bot
Runner, Bot Creator, and
device pools

Рабочая нагрузка Просмотреть и управлять
моими очередями

Администрирование View basic information
about users and roles

AAE_Администратор групп
Разрешения на просмотр всех групп
устройств и управление ими.

Прим.:  Эта функция не
предоставляет разрешения на
просмотр боты.

Информационная
панель

Просмотреть
информационные панели

Действия View my in-progress activity
Боты • Manage my credentials

and lockers
• Создать стандартные

атрибуты для учетных
данных

Устройства • View and manage my
Bot Runner, Bot Creator,
and device pools

• Create device pools
• Администрировать

группы устройств

Рабочая нагрузка Просмотреть и управлять
моими очередями

Администрирование View basic information
about users and roles

AAE_Администратор очереди
Разрешения на просмотр всех
очередей и управление ими.

Информационная
панель

Просмотреть
информационные панели

Действия View my in-progress activity
Боты • Manage my credentials

and lockers
• Создать стандартные

атрибуты для учетных
данных

Устройства View and manage my Bot
Runner, Bot Creator, and
device pools

Рабочая нагрузка • Просмотреть и
управлять моими
очередями

• Создать очереди
• Администрировать все

очереди
• Калькулятор SLA

Администрирование View basic information
about users and roles

AAE_Администратор миграции
ботов
This role allows users to view and
manage the бот migration process.

Прим.:  This role also has permissions
to view content, and check in and
check out боты from the Bots, My
 Tasks, and My MetaBots folders.
These folder permissions are implicit
and not displayed on the application.

Информационная
панель

Просмотреть
информационные панели

Действия View my in-progress activity
Боты • Просмотреть мои боты

• Manage my credentials
and lockers

• Создать стандартные
атрибуты для учетных
данных

• View and edit all
credential attributes
values

Package Manager Просмотреть пакеты
Устройства • «Зарегистрировать

устройство»
• View and manage my

Bot Runner, Bot Creator,
and device pools

Рабочая нагрузка Просмотреть и управлять
моими очередями

Audit Log Просмотреть все операции
в журнале аудита

Администрирование • View basic information
about users and roles

• Просмотр миграции
• Управлять миграцией
• Allow a Bot Runner to

perform migrations
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IQ Bot функций

Функция Разрешения

AAE_Валидатор IQ Bot
Для Bot Runner с лицензией IQ Bot.
Разрешения на доступа к экрану
валидатора IQ Bot. Ограниченный доступ к
функциям Control Room.

Информационная
панель

Просмотреть
информационные
панели

Действия View my in-progress
activity

Боты • Manage my
credentials and
lockers

• Создать
стандартные
атрибуты для
учетных данных

Устройства View and manage my
Bot Runner, Bot Creator,
and device pools

Рабочая нагрузка Просмотреть и
управлять моими
очередями

Audit Log View all audit log actions
Администрирование View basic information

about users and roles
IQ Bot • Просмотреть IQ Bot

• Просмотреть
обучаемые
экземпляры

• Запустить
проверяющий
элемент управления

AAE_Службы IQ Bot
Разрешения на доступ к консоли IQ Bot.
Ограниченный доступ к функциям Control
Room.

Информационная
панель

Просмотреть
информационные
панели

Действия View my in-progress
activity

Боты • Manage my
credentials and
lockers

• Создать
стандартные
атрибуты для
учетных данных

Устройства View and manage my
Bot Runner, Bot Creator,
and device pools

Рабочая нагрузка Просмотреть и
управлять моими
очередями

Audit Log View all audit log actions
Администрирование View basic information

about users and roles
IQ Bot • Просмотреть IQ Bot

• Просмотреть
обучаемые
экземпляры

• View learning
instances from the
same role

• Просмотреть
все обучаемые
экземпляры

• Запустить
проверяющий
элемент управления

• Создать обучение
на примерах

• Редактировать
обучение на
примерах

• Удалить обучение
на примерах

• Отправить обучение
на примерах в
работу

• Тренинг групп
обучения на
примерах

AAE_Администратор IQ Bot
Позволяет получать доступ ко всем
функциям IQ Bot.

Информационная
панель

Просмотреть
информационные
панели

Действия View my in-progress
activity

Боты • Manage my
credentials and
lockers

• Создать
стандартные
атрибуты для
учетных данных

Устройства View and manage my
Bot Runner, Bot Creator,
and device pools

Рабочая нагрузка Просмотреть и
управлять моими
очередями

Audit Log View all audit log
actions.

Администрирование View basic information
about users and roles

IQ Bot • Просмотреть IQ Bot
• Просмотреть

обучаемые
экземпляры

• View learning
instances from the
same role

• Просмотреть
все обучаемые
экземпляры

• Запустить
проверяющий
элемент управления

• Создать обучение
на примерах

• Редактировать
обучение на
примерах

• Удалить обучение
на примерах

• Отправить обучение
на примерах в
работу

• Тренинг групп
обучения на
примерах

• Просмотреть
домены

• Создать домены
• Импортировать

домены
• Экспортировать

домены
• Просмотреть

администрирование
• Просмотреть

и управлять
настройками

• Просмотреть
и управлять
миграцией
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Bot Insight функций

См. раздел Функции для доступа к Bot Insight.
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Discovery Bot функций

Функция Разрешения

AAE_Администратор Discovery Bot
Позволяет получать доступ к просмотру
всех процессов Discovery Bot. Управляет
созданием, удалением и редактированием
процессов.

Информационная
панель

Просмотреть
информационные
панели

Действия View my in-progress
activity

Боты Manage my credentials
and lockers

Устройства View and manage my
Bot Runner, Bot Creator,
and device pools

Рабочая нагрузка Просмотреть и
управлять моими
очередями

Администрирование View information about
users and roles

Discovery Bot • Просмотреть все
процессы

• Редактировать
процесс

AAE_Discovery Bot Analyst
Позволяет просматривать и редактировать
все утвержденные записи от назначенных
пользователей для данного процесса.
Permissions for system-generated aggregated
view of recordings to view, create, edit, and
delete views. Разрешения на создание,
просмотр, редактирование и удаление
возможностей для назначенных процессов.
Export the opportunity to a word document
and convert to a бот.

Информационная
панель

Просмотреть
информационные
панели

Действия View my in-progress
activity

Боты Manage my credentials
and lockers

Устройства View and manage my
Bot Runner, Bot Creator,
and device pools

Рабочая нагрузка Просмотреть и
управлять моими
очередями

Администрирование View basic information
about users and roles

Discovery Bot • View assigned
processes

• Просмотреть все
записи

• Просмотреть все
агрегирования

• Просмотреть
собственное
агрегирование

• Создать или
удалить
собственное
агрегирование

• Редактировать
агрегирование

• View system-
generated
aggregation

• Просмотреть
возможности

• Создать или
удалить
возможность

• Редактировать
возможность

• Преобразование в
бот

AAE_Пользователь Discovery Bot
Позволяет получать доступ к просмотру
процесса Discovery Bot, назначенного
пользователю. Создание и запуск средства
записи Discovery Bot для назначенных
бизнес-процессов. Разрешения на
просмотр, редактирование и удаление
собственных записей пользователя.

Информационная
панель

Просмотреть
информационные
панели

Действия View my in-progress
activity

Боты Manage my credentials
and lockers

Package Manager Просмотреть пакеты
Устройства • «Зарегистрировать

устройство»
• View and manage

my Bot Runner, Bot
Creator, and device
pools

Рабочая нагрузка Просмотреть и
управлять моими
очередями

Администрирование View basic information
about users and roles

Discovery Bot • Просмотреть
назначенный
процесс

• Просмотреть
собственную запись
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Automation Anywhere Robotic Interface функций

Функция Разрешения

AAE_Администратор
роботизированного интерфейса Информационная

панель
Просмотреть
информационные
панели

Действия View my in-progress
activity

Боты Manage my credentials
and lockers

Устройства View and manage my
Bot Runner, Bot Creator,
and device pools

Рабочая нагрузка Просмотреть и
управлять моими
очередями

Администрирование • View and edit users
• View basic

information about
users and roles

AARI • Cross team read
• Cross process read
• Global case

management
• Global process

management
• Global team

management

AAE_Диспетчер роботизированного
интерфейса Информационная

панель
Просмотреть
информационные
панели

Действия View my in-progress
activity

Боты Manage my credentials
and lockers

Устройства View and manage my
Bot Runner, Bot Creator,
and device pools

Рабочая нагрузка Просмотреть и
управлять моими
очередями

Администрирование • View and edit users
• View basic

information about
users and roles

AARI • Team management
• Управление

обращениями
• Task management

AAE_Пользователь
роботизированного интерфейса Информационная

панель
Просмотреть
информационные
панели

Действия View my in-progress
activity

Боты Manage my credentials
and lockers

Устройства View and manage my
Bot Runner, Bot Creator,
and device pools

Рабочая нагрузка Просмотреть и
управлять моими
очередями

Администрирование View basic information
about users and roles

AARI • Управление
обращениями

• Task management
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Export roles
You can export assigned users and Run as user roles to a CSV file to view folder permissions, and
included in offline audits and records.
Ensure that you are logged in to the  as the administrator.
You can export selected roles and their permissions to separate CSV files to view the following information:
• Role to user: Provides information about the users assigned to the role.
• Role to run-as user: Provides information about the run-as users assigned to the role.
• Role to permission: Provides information about the permissions assigned to the role.
• Role to folder permission: Provides information about the folder permissions assigned to the role.

You can download the CSV file with the exported roles from the Activity > Historical page.
1. Navigate to Administration > Roles.
2. Select the assigned users and Run as user roles that you want to export.
3. Click the Export checked items to CSV icon at the top-right corner of the table.

A message is displayed indicating that the exported CSV file is available from the Activity >
Historical page.

4. Click Continue.
5. Navigate to the Activity > Historical page and search for exported roles activity.

Прим.:  You can search for role activity by username. The role activity name uses the following
format: Role-Export: Roles_admin_03122022155910111.

6. Click the role activity that you want to download.
7. Click Download exported zip file.

The CSV file downloads to your local system as a zip file.

Manage Active Directory role mapping
An administrator or a user with permission to view and manage roles can view the details of the available
Active Directory role mappings.
Ensure that you are logged in to the  as the administrator.
By default, the Control Room will retrieve all security groups from the Users directory.
To create role mappings with filters for the Users directory along with other organizational units (OU), you
must update the um.properties file. In the Control Room, the Users directory is considered similar to
the OUs. Therefore, you must define the filter in the um.properties file.
For example, set the filter in the file as follows:

um.ldap.groupmapping.domain.filter='mydomain.com:OU1&groupFilter|
OU2&groupFilter|Users&groupFilter'

Прим.:  Group filters such as groupFilter are optional.

In this example, by applying this change to the um.properties directs the Control Room to perform the
following tasks:
1. Go to domain mydomain.com
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2. Retrieve all security groups from Organization Unit OU1 that have the group name starts with
groupFilter.

3. Retrieve all security groups from Organization Unit OU2 that have the group name starts with
groupFilter.

4. Retrieve all security groups from Users directory that have the group name starts with groupFilter.

This setting ensures that the users from the organization units OU1 and OU2 will be retrieved in addition to
the Users directory.

Recommendation:  Use filters to narrow down the group display as displaying larger number of groups
impacts the performance and makes troubleshooting difficult.

The filters defined in the um.properties file are stored in the database. When you update to a newer
version of the Control Room, the Control Room references the filters stored in the database because the
default um.properties file that comes with the installation will not contain these filters. If you define
new filters in the default um.properties file, the Control Room references the filters defined in the
um.properties file and overwrites the ones stored in the database.
Multiple Domain Mapping
Mapping supports multiple domains separated by a coma.

um.ldap.groupmapping.domain.filter='mydomain.com:OU1&groupFilter|
OU2&groupFilter|Users&groupFilter,mydomain2.com:OU3|OU4'

In the example above, the Control Room will perform the additional processes:
1. Go to domain mydomain2.com
2. Retrieve all security groups from Organization Unit OU3.
3. Retrieve all security groups from Organization Unit OU4.

Retrieving security groups from nested OUs
Example for retrieving security groups from nested OUs.
In the following example organization, consider "Marketing" as the parent OU with additional nested OUs
and security groups located in each of these nested OUs.
• Маркетинг

• Группа 1
• Группа 2
• US_OU

• Группа 3
• California_OU

• Группа 4
• NoCal_OU

• Группа 5

• SoCal_OU
• Группа 6
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By adding the following entry, Control Room will retrieve all groups, group1, group2, group3, group4,
group5 and group6 from Marketing and the nested OUs.

um.ldap.groupmapping.domain.filter='mydomain.com:Marketing'

Прим.:  Providing nested OU in the entry is not supported.

Active Directory role mapping
Navigate to Administration >  > Roles > Active Directory role mappings and the page displays any
role mappings that are created in the Control Room. You can view or edit the role mappings. You can also
create new role mappings or restart the role synchronization process between the Control Room and Active
Directory.
When enabled, this synchronization process is triggered once a day (1440 minutes) by default. You can
trigger synchronizations in any interval by changing the number of minutes. We recommend that you set
the interval settings larger than the default.

Recommendations:
• You should set the interval settings larger then the default setting of 1440 minutes.
• Do not use both Import and Do not import mappings in the same system because it may complicate

use cases and make troubleshooting more difficult to correct any issues.
• If both Import and Do not import mappings are defined and a user is included in both mappings,

then the Import mappings take precedence over the Do not import mappings.
Consider these examples:
• AD Mapping A = Role A – Group A – Import users from this group into Automation 360
• AD Mapping B = Role B – Group B – Do not import users from this group

Where user D is included in both Groups A and B within Active Directory.
User D will be created in Automation 360 and will be assigned Role A.
• AD Mapping A = Role A – Group A – Import users from this group into Automation 360
• AD Mapping B = Role B – Group B – Do not import users from this group
• AD Mapping C = Role C – Group C – Import users from this group into Automation 360

Where user D is included in Groups A, B, and C in Active Directory (AD).
User D will be created in Automation 360 and will be assigned to Role A and Role C.

One or more available role mappings that match your search criteria appear in the Role Mapping table.

Прим.:  The role mappings page displays only the list of mappings and does not validate the mappings
by default. Because the changes in security groups and roles are infrequent and take more time in case
of slow network or higher number of mappings, the page displays only the list of mappings. To configure
default validation on the role mappings page, in the um.properties file, add the following entry:
um.ldap.groupmapping.sync.on.get.mappings=true. Validation of role mappings occurs when
you sync the role mappings between the Active Directory and the Control Room.

You can run automations either on the device which is set as your бот running device or from a device
pool for which you have consumer privileges (Create a user ). When using Active Directory role mapping, if
you want any mapped Active Directory user to be able to use more than one device, you must configure a
device pool (Create device pools).
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Sync Active Directory role mapping
Manually or automatically synchronize (sync) role mappings between the Active Directory and Control
Room.

Automatically synchronize Active Directory role mapping

By default, synchronizing between Active Directory and Control Room occurs by default at the time interval
of 1440 minutes (one day). The time interval for synchronization can be changed in the Active Directory
role mappings main page.

Прим.:  As this can be a time-consuming and an expensive operation, set the role synchronization time
period to the default value of 1440 minutes (1 day).

Manually run or restart synchronizing Active Directory role mapping

To run or restart automatic synchronizing between the Active Directory and Control Room, do this: From
the Control Room go to the Active Directory role mappings page and click the Sync roles from
Active Directory option.
This starts the synchronizing process immediately and continues to run it automatically based on the time
interval set.

Cancel automatic synchronizing Active Directory role mapping

To cancel automatic synchronizing between Active Directory and Control Room, do this: From the Control
Room go to the Active Directory role mappings page and click the Cancel Sync option to turn off the
periodic automatic sync.

Events that require Active Directory role mapping sync

Sync the role mappings whenever these events occur:
• Changes to AD groups

If any group that is mapped is deleted from the AD, the mappings must be validated before they are
deleted because the group is no longer available.

• Update to the license file
Updating the license file can change the available roles. Mappings must be synchronized before
updating the roles.

Прим.:  After a sync, the user must wait a few seconds for the updated changes to appear.

Create Active Directory role mapping
When users are created, they automatically inherit the roles assigned to their Active Directory security
groups. Create the mapping before synchronizing the user and roles during the user login or background
process.
To complete the task, you must have AAE_Администрирование role assigned to you. Ensure you are
logged in to the Control Room as the administrator.
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In order to create a role mapping, as the administrator will have to provide the following information:
• Unique mapping name.
• The targeted domain where the security groups will pulling the credentials from (see um.properties for

details).

Прим.:
In order to avoid to import a long list of users, a specific security group should be created on the AD side
that has only the users who will access Control Room is recommended.

Map a single AD security group to one or more Control Room roles. Create any roles you want to use with
the Active Directory security groups. You can also use the default roles available in the Control Room. .

Прим.:  It is recommended that the AAE_Admin role not be used.

1. Войдите в Control Room.
2. Navigate to Administration > Roles.
3. Click Active Directory Role Mapping.
4. Click Create Role Mapping.
5. Введите Имя.
6. Click the Active Directory domain drop-down and select an available domain.
7. Use the Active Directory security group field to search for a group.

For example, if you have a group named Certified Publishers, search for Certified. All the
groups that contain Certified in their name are listed in GROUPS.

8. Choose whether Import users or Do not import users.
Вариант Outcome

Import users All the users who are assigned for the selected
security group will be created and assign the
mapped roles and licenses in Control Room. If
users already exist in Control Room, they will be
updated with the latest roles and licenses from
the mapping.
If synchronization process is enabled and
triggered, the existing Control Room users will
have the updated roles and licenses from the
mapping.
If there are new users added to the security
group on the Active Directory side, these users
will be created in the Control Room.
If there are users removed from the security
group, these users will be deleted from Control
Room.
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Вариант Outcome

Do not import users After the role mapping is created; no user will be
created in Control Room. How this mapping is
being used in this deployment:
• On the Create user configuration page,

when you create a new user, the role(s) will
automatically be assigned to the new user if
any of the user security group maps to the
existing role mapping.

• If synchronization process is enabled and
triggered, any existing Control Room users
whose security group maps to any role
mappings will get the role assignment
updated.

9. Click the right arrow (→) to add your selection.
10. Select the required role from the list of Available roles.
11. Click the right arrow (→) to add your selection.
12. Select the device licenses to assign to the security group.

License mapping is only supported when the Import users options is selected.

Прим.:  The Do not import users option does not support license assignment. Administrators
will be required to map the licenses manually for users. If any of the licenses that are defined in the
mappings became unavailable during the synchronization process (not enough license), licenses will
not be assigned to the users. Therefore, ensure that there is enough licenses before creating the
mappings.

You can run automations either on the device which is set as your бот running device or from a
device pool for which you have consumer privileges (Create a user ). When using Active Directory role
mapping, if you want any mapped Active Directory user to be able to use more than one device, you
must configure a device pool (Create device pools).

13. Click Create Mappings.

When the synchronization runs, all users with the assigned roles are updated.

Edit Active Directory role mapping
As an Automation Anywhere Control Room administrator, edit the Active Directory security group mappings
assigned to roles in the Control Room.
Ensure that you are logged in to the  as the administrator.
Ensure that the mapping name is unique and cannot be duplicated. If you rename a map with an existing
mapping name, an error message appears stating that the same name already exists. Changes to mapping
name or roles are updated in the audit log.
1. Navigate to Administration > Roles.
2. Click Active Directory Role Mapping.
3. Hover over the Actions icon for the role and select Edit role mapping.
4. Supply any required changes for Role Mapping.

Edit the roles by either adding or removing roles from the Available roles list, except Bot Insight
roles. If you assign Bot Insight roles, an error message appears stating that the role mapping cannot
be updated as it contains unsupported roles.
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Прим.:  You cannot edit the rest of the fields. The process to update mappings and synchronize users
starts at a previously defined interval or when you manually update the mappings.

5. Щелкните Сохранить изменения.

When the LDAP sync runs, all users with the assigned roles are updated.

Delete Active Directory role mapping
An administrator or a user with permission to view and manage role can delete role mappings listed in the
Role Mapping table.
Ensure that you are logged in to the  as the administrator.
1. Navigate to Administration > Roles.
2. Click Active Directory Role Mapping.
3. Hover over the Actions icon for the role and select Delete role mapping.
4. Click Yes, delete.

Настройки
Вкладка Настройки позволяет настроить подключение к Credential Vault, включить уведомления по
электронной почте, интегрировать Control Room с репозиторием Git, включить режим безопасной
записи и настроить аутентификацию пользователей.

Боты

• В режиме безопасной записи конфиденциальные данные не сохраняются в боты. Если включен
режим безопасной записи, то боты не записывают значения определенных свойств и не
сохраняют образы приложений. You can enable this setting for some or all users of the Control Room.

Прим.:  Режим безопасной записи применяется только к боты, которые создаются или
редактируются после включения этого режима.

Чтобы включить или отключить режим безопасной записи, щелкните Редактировать на вкладке
Боты. См. раздел Безопасная запись.

• При валидации Бот на этапе предварительной обработки выполняется дополнительная
валидация времени компиляции на перенесенных боты, чтобы сэкономить ваше время и усилия.
По умолчанию для функции валидации Бот установлено значение Выкл.

Прим.:  Для просмотра и редактирования параметров валидации требуются права
администратором Control Room.

Navigate to Administration > Settings > Bots and set the бот validation option to On to detect
compilation errors with боты.
Для новых боты валидация осуществляется во время выполнения бот. Для перенесенных боты
эта проверка выполняется сразу после миграции бот согласно конфигурации.
Например, если родительский бот вызывает дочерний бот, а дочерний бот содержит
ошибки компиляции, эти ошибки отображаются при попытке выполнить родительский бот.
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Этим гарантируется, что ошибка не возникнет в середине автоматизации и не сделает ее
незавершенной.
На странице результатов миграции Бот выберите бот, который необходимо проверить. Чтобы
просмотреть подробные сведения, щелкните символ «три точки» под вкладкой Причина. Если
для параметра валидации Бот задано значение Вкл., то каждому боты с ошибками времени
компиляции в отчете о миграции отводится отдельная строка.
Перенесенные боты с ошибками компиляции отображаются в разделе Успешно с просмотром в
отчете о миграции. В результате вы получаете список боты, которые требуют вашего внимания.

Устройства

Когда появляется новая версия Bot Agent, этот продукт автоматически обновляется.

IQ Bot

Просмотрите адрес веб-сайта, на котором IQ Bot установлен в настоящее время, если это
применимо. Чтобы обновить URL-адрес IQ Bot, щелкните Редактировать.

Эл. почта

Перед тем как войти в Automation Anywhere Control Room, все пользователи должны подтвердить
учетные записи электронной почты, перейдя по полученной ссылке подтверждения, задать пароль и
контрольные вопросы. По умолчанию уведомления по электронной почте отключены. Чтобы внести
изменения, наведите указатель мыши на значок Редактировать.

Редактирование уведомлений по электронной почте

Интеграция с Git

Удаленный репозиторий Git должен поддерживать Git LFS (Large File Support). Боты
синхронизируются с помощью стандартной передачи Git через HTTPS.

Login settings

For security, privacy, or any other pertinent announcement, you can provide an additional statement, such
as consent text, in the Login settings section. The statement is visible to users every time they log in to
the Control Room.
This statement on the login page is disabled by default. If you enable it, you can also provide an option
(using a check box) for users to read and accept the statement before logging in to the Control Room.

Настройки безопасности

Пароли Настройте требования к паролям для всех
пользователей Control Room. Пароль должен
содержать следующее:
• цифру,
• буквенно-цифровой символ,
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• символ,
• прописную букву.

Для пользователей On-Premises. Флажки
установлены. Пользователь может
устанавливать и снимать их.
Для пользователей Cloud. Флажки сняты.
Пользователь не может устанавливать и снимать
их.

API-Key duration The generated API-Key is used to authenticate
users. You can customize how long the generated
API-Key is valid to authenticate users until either:
• A selected duration is reached (in minutes or

days), or
• A new API-Key is generated

Прим.:  You determine the validity duration based
on your organization's requirements. Maximum
supported API-Key duration is 1 to 14,398,560
minutes, or 1 to 9,999 days.

Настройки сеанса ожидания You can enable settings to automatically time out
users from the Control Room browser session
after the specified minutes of inactivity. You can
configure the inactivity time in the range of 10-60
minutes in the Time-out session setting field.
You can configure the session using increments of
10 minutes. The default value is 20 minutes, which
means you will be logged out of the session after
20 minutes of inactivity.

Настройки загрузки файлов As an Administrator, you can restrict the upload of
executable files (dll files, media type application/x-
msdownload) to prevent a security breach. To use
this feature, enable the File upload settings in
Administration > Settings > Security settings.

Notification settings

Manage the notification settings for notification categories and channels. The notification settings defined
by the Control Room administrator are applicable for all the Control Room users. Based on these defined
settings, Control Room users will be notified about the events.
Administer notifications for Control Room.

User authentication

Configure the Control Room to authenticate users through the database option or switch to a SAML Identity
Provider (IdP).

Настройка аутентификации SAML
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Внешнее хранилище ключей

External key vaults provide a way to securely store and retrieve credentials using a third-party key manager
such as CyberArk, Azure, and AWS Secrets Manager.
Задачи, связанные с данной
Настройка аутентификации SAML
Switch an authenticated environment Control Room database to a SAML identity provider (IdP).
Редактирование уведомлений по электронной почте
Отредактируйте сведения о сервере электронной почты, который будет использоваться для
отправки уведомлений по электронной почте.

Package updates
The delivery of packages is developed to be separate from the main platform updates. This will help us
respond quickly to changes and fixes required and provide the flexibility to deliver updates in packages,
going forward.

A new пакет and new пакет version is downloaded and installed if it is compatible with your Control Room
version.
• Cloud users cannot turn off this automatic installation of a new пакет and new пакет version, but the

пакет administrator can control the status of the new пакет version.
• For On-Premises users, the automatic пакет download capability is disabled by default, but package

administrators can enable it.

Прим.:  From Automation 360 v.27, the automatic пакет download capability is enabled by default for any
On-Premises new installation. As a пакет administrator, you can disable this feature.
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This capability is enabled differently for Cloud and On-Premises Control Room instances, as listed in the
following table:

Seamless пакет update
capability

Cloud Control Room On-Premises Control Room

Download пакеты from
Automation Anywhere Cloud

Enabled by default and cannot
be disabled.

Disabled by default and can be
enabled.

Прим.:  From Automation
360 v.27, it is enabled for new
installation and can be disabled.

Set downloaded пакет to
default version

Enabled by default and can be
disabled.

Enabled by default and can be
disabled.

Прим.:  After the Automation 360 v.27 upgrade, when a new пакет (first version) is added to the Control
Room and if the пакеты setting is set to Disable for the new version of the пакет, note that this пакет
will show the status as Enabled and set as default instead of Disable.

• Cloud users: Automatic пакет updates for Cloud Control Room
• On-Premises users: Автоматические обновления пакет для On-Premises Control Room

We recommend бот developers always use the latest version of the пакеты because that version provides
the latest innovations and all the code and security fixes from previous versions. Note that this capability
does not impact existing боты, which continue to run unchanged. Боты developed with a particular пакет
version will continue to do so unless explicitly changed by the бот developer. However, if you want to
modify existing боты to use the default version of a пакет, you can use the Update bots to default
package version feature. Подробнее см. в разделе Обновление боты до версии пакет по умолчанию.

Автоматические обновления пакет для On-Premises Control Room
Настройте параметры On-Premises Control Room, чтобы получать обновления пакет из Cloud
автоматически или только при обновлении Control Room вручную.
Возможность бесперебойного обновления пакет является частью наших усилий по обеспечению
доступности инноваций и усовершенствований. Функционал платформы Automation 360
обеспечивает прогнозируемый, качественный и бесперебойный доступ к последним версиям со
всеми улучшениями.
Когда эта возможность бесперебойного обновления включена, Control Room может загружать
новые пакеты и новые версии существующих пакеты из Automation Anywhere Cloud, как только они
становятся доступны. Вновь загруженные версии пакет автоматически устанавливаются как пакеты
по умолчанию, чтобы клиенты могли начать пользоваться этими версиями пакет на постоянной
основе, как только пакеты становятся доступны.

Прим.:  To automatically download newly released пакет versions, the Control Room uses the following
URL and port number:
• URL: https://aai-artifacts.my.automationanywhere.digital/packages/<package-

jar-file-name>
• Port number: TCP 443 (HTTPS)

Обратите внимание, что эта возможность не влияет на существующие боты. Существующие
боты продолжают работать без изменений. Эти новые версии пакет также обратно совместимы с
существующей версией платформы.
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Настройка пакеты для On-Premises

Убедитесь, что вы вошли в On-Premises Control Room как администратор.
1. Перейдите в раздел Администрирование > Настройки > Пакеты.
2. Измените параметр Пакеты.

Страница откроется в режиме редактирования.
3. Выберите Вкл для автоматической загрузки и установки новых пакеты из Automation Anywhere

Cloud в Control Room.
По умолчанию для настройки Автоматически обновлять пакеты из облака установлено
значение Выкл.

Прим.:  From Automation 360 v.27, this capability is On for the new installation of the On-Premises
Control Room.

Если вы включите эту настройку, система будет проверять наличие новых пакеты каждые
12 часов и автоматически устанавливать их, если новые пакеты будут доступны.

Прим.:  Новая версия пакет загружается и устанавливается только в том случае, если она
совместима с вашей версией Control Room.

4. Enable the settings to set the status of the new пакет.
This is applicable for new пакеты downloaded from the Cloud and the Control Room upgrade. By
default, this setting is enabled and set as default.
• Enable and set as default: Select this option to automatically set the new version of a пакет as

the default version.
• Enable: Select this option to manually set the default version after the пакет update.
• Disable: Choose this option to automatically disable the new version of a пакет.

5. Сохраните настройки.

Automatic пакет updates for Cloud Control Room
Configure the Cloud Control Room settings to get пакет updates from the Cloud automatically.
Ensure that you are logged in to the  as the administrator.
When a new пакет or a new пакет version is released in the Cloud, the пакет version will automatically
get installed on Control Room. This automatic installation of a new пакет version cannot be turned off by
cloud users and can only control the status of the new пакет version after it is installed.
1. Перейдите в раздел Администрирование > Настройки > Пакеты.
2. Измените параметр Пакеты. Страница откроется в режиме редактирования.
3. Enable the settings to set the status of the new пакет.

• Enable and set as default: Select this option to automatically set the new version of a пакет as
the default version.

• Enable: Uploads and enables the пакет, but the пакет is not set as the default пакет. Bot Creator
have to specifically select non-default пакеты to use them for creating боты.

• Disable: Choose this option to automatically disable the new version of a пакет.

4. Сохраните настройки.
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Понятия, связанные с данным
Preload пакеты
You can preload пакеты on your local device to shorten the бот runtime.

Manage device settings
Control Room administrator can configure the device settings to automatically set a user's default device
when that user logs into Control Room.
Задачи, связанные с данной
Configure screen resolution for a device session
For user devices, you can set the screen resolution of the Bot Runner for every бот deployment through
the RDP in the Control Room.
Configure temporary devices
Configure your device settings to automatically delete a temporary device when the device is disconnected
from the Control Room after a certain time interval.
Configure threshold settings for user devices
Configure the CPU utilization and device memory threshold values to control the concurrent бот
deployment on user devices based on resource utilization.
Configure auto-login settings
Configure auto-login settings in the Control Room to either create user sessions or reuse existing user
sessions to reduce the бот startup time.

Configure general settings
Configure the default device setting for temporary or non-persistent devices so that users of such devices
users do not have to log in to the Control Room to mark their device as a temporary device.
1. Перейдите в раздел Администрирование > Настройки > Устройства.
2. Click Edit in the General tab.
3. Чтобы устройство выполнившего вход пользователя автоматически становилось устройством по

умолчанию, убедитесь, что выбран параметр Включено.
Этот параметр установлен по умолчанию. Вы можете изменить его на Отключено, если
не хотите, чтобы устройство выполнившего вход пользователя становилось устройством по
умолчанию.

4. (Optional) While enabling users to switch Control Room
5. Щелкните Сохранить изменения.

Configure browser extensions
You can customize the browser extension settings for user devices at the device level. Customizing the
setting helps you to continue to use browser-based automations seamlessly even when there is an update
to the browser extension.
• You must be a Control Room administrator to configure this setting.
• You must have installed Bot Agent version 21.222 or later.
• You must have installed the Bot Agent with installation type as system-wide.

By default, the Google Chrome and Microsoft Edge browser extensions are enabled on all Bot Agent
devices. When this option is enabled, the browser extensions are automatically updated on all the
connected devices through a single click.
1. In the Control Room, navigate to Administration > Settings > Devices.
2. In the Browser extensions settings, select Edit and then select one of the following options:
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• Enabled: Select this option to enable the Google Chrome or Microsoft Edge extensions on all the
connected devices.

• Disabled: Select this option to disable the automatic update of browser extensions. This option is
applicable only when a Bot Agent is upgraded or a new Bot Agent is installed.

• Force disable Chrome and Edge extensions from all bot running devices: Select this
option when you want to manually upgrade the browser extension.
This option disables browser extensions on all the Bot Agent devices.

Прим.:  These settings on the browser extension depends on the
ExtensionInstallForceList group policy. None of these settings can be applied if the
ExtensionInstallForceList group policy with Automation Anywhere extension is not
available in the system.

Прим.:  Selecting this option might disrupt the functioning of your browser-based automation.

Consider the following when configuring the browser extensions option:
• If the Browser extensions option is selected and you disable this option when the

Force disable extension on all bot running devices option is unselected, then the
ExtensionInstallForceList group policy is not applied on the devices that are newly
registered or upgraded. You will have to enable the extension manually on the newly registered or
upgraded devices.

• If the Browser extensions option is selected and you deselect it, with the Force disable
extension on all bot running devices option selected, the ExtensionInstallForceList
group policy is deleted from all the Bot Agent devices and you must manually update the browser
extension.

• If the Browser extensions option is unselected and you select it, the group policy changes are
pushed to all the Bot Agent devices.

Прим.:  Automation Anywhere does not interfere with the ExtensionInstallForceList group
policy if it is already present on the system, However, if a key by name 1 is already present in the
ExtensionInstallForceList folder, create a key name with the subsequent number, in this case,
2. See ExtensionInstallForcelist for Google Chrome or ExtensionInstallForcelist for Microsoft Edge.

.

Configure log collection
The log collection configuration enables you to collect log entries from the devices connected to the
Control Room.
You can view the system log information on your device at the following locations:
• Bot Agent installed as admin user: C:\ProgramData\AutomationAnywhere\BotRunner\Logs
• Bot Agent installed as local user or non-admin user: %userprofile%\AppData\Local

\AutomationAnywhere\BotRunner\Logs

.
The following logs are collected:
• Node manager logs
• Bot launcher logs
• Browser extension logs
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You can choose to collect one of the following log-level information:

Прим.:  In the production (PROD) environment, we recommend that you set the log file configuration
level to INFO for optimal performance.

• Info (default): Информационные сообщения, которые отображают ход выполнения приложения
• Debug: Fine-grained information that is useful for debugging an application
• Trace: Captures every behavior of the application in detail

1. Перейдите в раздел Администрирование > Настройки > Устройства.
2. Click Edit in the Log collection configuration tab.
3. To configure the level of log collection, select Info, Debug, or Trace.
4. Set the maximum log file size between 1 MB and 100 MB.
5. Set the maximum number of log files between 1 and 500.
6. Сохраните настройки.

Configure screen resolution for a device session
For user devices, you can set the screen resolution of the Bot Runner for every бот deployment through
the RDP in the Control Room.
Эта задача выполняется пользователем, который хочет создать и развернуть . Для выполнения этой
задачи вы должны обладать необходимыми правами и разрешениями, а также вам должен быть
разрешен доступ в  в качестве лицензированного пользователя.
The RDP session is created using the set screen resolution during бот deployment.
1. Перейдите в раздел Администрирование > Настройки > Устройства.
2. Edit the Resolution settings for a device session field.
3. Set the resolution by either selecting a predefined value from the Screen resolution drop-down list

or by selecting Custom and entering the values you want.
Note that the screen resolution settings are applicable only when you use RDP-based deployments.
For regular deployments, a Windows session is created using the existing resolution settings of the
device. In this case, the screen resolution set in the Control Room is ignored.

Прим.:  When resolution dependent пакеты are used to build боты, any screen resolution difference
between the Bot Creator and Bot Runner device will impact the боты during runtime. Therefore,
ensure the resolution settings on devices match when you create and run боты. См. раздел Screen
resolution dependent пакеты.

4. Select the Do not allow devices to override resolution settings option.
When you select this option, the resolution settings cannot be changed at the device level.

5. Щелкните Сохранить.

Screen resolution dependent пакеты
The screen resolution between the Bot Runner and Bot Creator device should be consistent as when
resolution-dependent пакеты are used to build боты, any screen resolution difference between the Bot
Creator and Bot Runner device will impact the боты during runtime.
Ensure the resolution settings on Bot Creator and Bot Runner devices match when you create and run
боты. Review the table given below for information on the resolution-dependent пакеты and their
attributes.
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Пакет Effects of display parameter changes Resolution-
dependent
attributes

Распознавание
изображений

If we use the Распознавание изображений пакет
in a computer that has a different resolution,
scaling, or zooming than the resolution that was
configured in the system, it can affect the output as
it works on image pixel values and the features.
For RDP machines, when you configure
Распознавание изображений пакет in a different
machine and run it on an RDP machine with same
resolution and scaling, and if RDP is using a different
display driver, the capture might not be accurate. It
can render image with slightly different pixel values
that can cause a reduction of matching percent.

X, Y, width, and
height

Мышь The Mouse > Click action requires X and Y co-
ordinates to capture the UI element. If there is a
change in screen resolution, scaling, or zooming, the
coordinates might move, and it might click different
coordinates. Due to this, the Click action will fail
to capture the specific UI element. If you are using
the RDP machine with the same resolution, scaling,
or zooming then it will not create any issue as the
Мышь пакет does not depend on the pixel value.

X, Y

Интеграция
приложений

The App Integration > Capture area action
requires X and Y co-ordinates to capture the text
from a window. Any change in screen resolution,
scaling, or zooming might cause change in the
coordinates, and the correct text is not captured. In
the RDP machine, use same resolution, scaling, and
zooming so that you do not encounter any issues.

X, Y, width, and
height

Экран The Screen > Capture area action requires X
and Y co-ordinates to capture the screenshot of the
application window area. Use the same resolution
and scaling in the RDP machine so that the output is
not affected.

X, Y, width, and
height

Распознавание текста
(OCR)

The OCR > Capture area action uses the X and
Y co-ordinates to extract text from a specified area
in the selected window. Ensure you have the same
resolution, scaling, and zooming in the RDP machine
so that extraction of the text is not affected.

X, Y, width, and
height

Configure temporary devices
Configure your device settings to automatically delete a temporary device when the device is disconnected
from the Control Room after a certain time interval.
Ensure that you are logged in to the  as the administrator.
1. Перейдите в раздел Администрирование > Настройки > Устройства.
2. Edit the Temporary devices - auto delete settings.
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3. Use plus (+) or minus (-) to select the number of Days, Hours, or Minutes to wait before the
temporary device should be deleted automatically.
The default time is 24 hours.
You can also manually delete the temporary device from the My devices page in the Control Room.

4. Сохраните настройки.

Configure threshold settings for user devices
Configure the CPU utilization and device memory threshold values to control the concurrent бот
deployment on user devices based on resource utilization.
Ensure that you are logged in to the  as the administrator.
Based on the CPU utilization and device memory threshold values, you can determine whether to deploy
боты on user devices. If the threshold value is the same or more than the value provided, боты are not
deployed on user devices.
The default values for CPU utilization and device memory are based on the following parameters:
• When the frequency of data collection is 10 seconds, the system collects 6 data points in 1 minute.
• When time interval to upload data is 120 seconds, the system uploads 6 data points to the Control

Room every 2 minutes.
• When the moving average time window is 2 minutes, the system uses the last 12 data points to

calculate the average resource utilization.

1. Перейдите в раздел Администрирование > Настройки > Устройства.
2. Edit Threshold settings for multi-user devices.
3. Optimize the behavior for concurrent sessions by choosing one of the following options:

• Не включать параметры порога
Use this option to deploy боты on single-user devices.

• Enable threshold settings to set the maximum values:
a. Enter the CPU and memory utilization frequency of data collection.
b. Enter the time interval to upload data.
c. Enter the moving average time window.
d. Enter the CPU threshold limit for new бот deployments on a device.
e. Enter the memory threshold limit for new бот deployments on a device.

Use this option to deploy on multi-user devices.

You can either enter the values or click the plus (+) or minus (-) signs to increase or decrease the
limit.

4. Сохраните настройки.

Configure auto-login settings
Configure auto-login settings in the Control Room to either create user sessions or reuse existing user
sessions to reduce the бот startup time.
Ensure that you are logged in to the  as the administrator.
Auto-login enables you to deploy a бот for unattended Bot Runner after automatically logging on to a
machine and restoring the machine to its original locked/unlocked state after completing the deployment.
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Прим.:  The Run as user device credentials are used for Auto-login.

Configure auto-login settings to either create new user sessions or reuse existing sessions in the following
scenarios:
• Before deploying a бот, some applications are kept running to accommodate a delay in the application

launch.
• When Windows updates or Active Directory policy updates are pushed after a user logs in, changes in

the automation environment might affect бот execution.
• Logging off from temporary or non-persistent devices stops бот execution.
• You can reuse existing user sessions when your company's IT policy prevents you from providing device

user password for auto-login credentials.
• To bypass legal disclaimers on RDP-based deployments.

1. Перейдите в раздел Администрирование > Настройки > Устройства.
2. Edit the Auto login settings.
3. Необязательно: External key vault setting.

4. Choose how to run боты on user sessions by selecting one of the following options:
• Always create a new session

Select this option for desktop deployments where it is possible to create user sessions on devices.
• Reuse an existing session

Recommendation:  Select this option for auto-login settings in the Control Room to use event
triggers on unattended Bot Runner and to run боты when a device is locked or is in a disconnected
state (such as RDP).

Available options to lock or unlock the session are:
• An existing locked session
• An existing unlocked session
• A disconnected session
• Allow users to change these settings for each device

Use this option for deployments on devices where it is not possible to create user sessions.

Прим.:  When you use the Reuse an existing session option, ensure user sessions are
available. If there is no existing user session, triggers and бот deployments will fail.

• Reuse an existing session, if available
Use this option if you must create a new session or reuse an existing session. If a session does not
exist, create a new session and leave it unlocked for next user session after боты complete their
run from the following:
• A new session
• An existing locked session
• An existing unlocked session
• A disconnected session

5. To allow a user to change the auto-login settings at the device level, go to Administration > My
Devices and select Allow changes.
The Do not allow changes option disables the user-level auto-login settings for user sessions.

6. Сохраните настройки.
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Ссылки, связанные с данной
Устройства
Устройство — это компьютер, с которого пользователь подключается к Control Room, чтобы
создавать или запускать боты. Manage devices that are registered to the Control Room through the
Devices page located in the Manage tab.

Configure advanced options
Configure the default settings for your device. For example, if you can change the default location of global
cache as per your requirement.
A Control Room administrator can use any of the following optional instructions to change the default
settings:
1. Перейдите в раздел Администрирование > Настройки > Устройства.
2. Click Edit in the Advanced options settings.
3. Click Allow changes on the Edit device page to change the default settings and enable users to

make changes on the device page.
4. Enter a new filepath for global cache in the Global Cache Location field.

This option is available in the Control Room for all devices but can be used only by devices that have
the All Users/System Level (Recommended) option selected when installing the Bot Agent.

Прим.:  Если указанный путь недействителен на устройстве, то используется путь по
умолчанию.

5. Use the following fields to enter custom values:
• Autologin timeout: time duration within which a user can auto-login to the device.
• Bot launcher JVM options: send dynamic properties supported for Java.

For example, you can use this option to increase the memory of the бот launcher.
• Maximum simultaneous downloads: set the number of simultaneous downloads.

For example, 5 downloads including dependent files.
• Console readiness wait time: set a wait time for the console to be displayed when you run a

бот.
• Bot response wait time: set a wait time for an active бот session.
• RDP command options: provide different RDP-based commands.

For example, ports-related commands.
• Log collector: allows the device to send logs to Control Room.

6. Щелкните Сохранить изменения.

Переключение регистрации устройства между экземплярами Control
Room
Настройте параметры устройства в Control Room, чтобы позволить однопользовательским
устройствам легко переключаться между разными экземплярами Control Room для запуска боты в
нескольких окружениях. Этот параметр позволяет вам зарегистрировать Bot Agent на нескольких
экземплярах Control Room без удаления Bot Agent.
Ensure that you are logged in to the  as the administrator.
• Для включения параметра переключения необходимо разрешение «Просмотреть и управлять

ВСЕМИ устройствами».
• Вы должны включить параметр переключения в обоих экземплярах Control Room.
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• Вы можете переключаться между экземплярами Control Room только в том случае, если
экземпляры находятся в одной и той же сборке.
Например, если один экземпляр Control Room находится в Сборка 9664, а другой экземпляр
находится в Сборка 8815, вы не можете переключать пользовательское устройство между двумя
экземплярами Control Room. Оба экземпляра должны быть либо в Сборка 9664, либо в Сборка
8815.

1. Перейдите в раздел Администрирование > Настройки > Устройства.
2. Отредактируйте Общие настройки.
3. Select Enabled to enable the local device as the default бот running device after a user logs into the

Control Room.
4. Select Enabled to enable a single-user device to be switched to another Control Room without

reinstalling the Bot Agent.
Additionally, the Allow fast switching option allows you to switch the Bot Agent with a single click.

Прим.:  Fast switching is recommended only if there is no change in the network configuration when
connecting to a new Control Room. The first time you switch the Bot Agent to a new Control Room,
the device lifespan information (that is, whether the device is Persistent or Temporary) is copied
over to the new Control Room. No other configuration information is copied over.

If this setting is not enabled, you must uninstall Bot Agent first and then reinstall it to switch device
registration to different Control Room instances.

5. Необязательно: For additional security, you can enable the following setting in the Validate device
credentials field to validate the device credentials prior to бот deployment:
• Device credentials for all users: Validates the device credentials for Bot Creator, attended Bot

Runner, Непрофессиональный разработчик, and unattended Bot Runner users.
• Device credentials for un-attended bot runner users only: Validates the device credentials

for unattended Bot Runner users only.

6. Сохраните настройки.
7. Log in as a Bot Creator user to a Control Room configured in a different environment to verify that

users can switch between instances.
The Connect device option is available when you click the device icon in the Control Room panel.

Задачи, связанные с данной
Switch Bot Agent to a different Control Room
Switch the Bot Agent on a registered device to work with a different Control Room manually when you
work on automations using different environments.

Add access IP addresses
Use this setting to limit user login access to the Control Room URL based on IP addresses or subnets that
you specify in a list. You add IP address ranges using the Classless Inter-Domain Routing (CIDR) format,
and you can add multiple CIDR ranges.

Прим.:
If a user attempts to log in to the Cloud Control Room using an IP address that is not included in the
access list, an error message displays indicating invalid user or user credentials.

Ensure that you are logged in to the  as the administrator.
You must have access to Administration > Settings page with view, add, or edit permissions.
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Specify a list of IP addresses or IP subnets to permit access to the Cloud Control Room URL and API. If
your network egress uses dynamic IP addresses, then the ranges you enter must include the entire range
of dynamic IP addresses that can be assigned outbound traffic. For example, to specify a single IP address
use, 10.10.10.12/32; or to specify an IP address range, use 192.168.20.0/24.

Прим.:  When using SAML for authentication, use the network access capabilities of the Identify provider
to restrict access to specific allowed IP addresses. Ensure all allowed IP addresses configured are removed
before switching to SAML for authentication. For more information, please consult Unable to Set up SAML
authentication for Control Room (A-People login required).

Perform the following steps to add an IP address or subnet to the list of permitted network access
addresses:
1. Log in to the  as the administrator.
2. Navigate to Administration > Settings > Network settings.
3. Click Edit to add to or edit the listed IP addresses.

Прим.:  There is a limit of 25 independent entries in the access permitted table. An entry can be a
single IP address or an IP subnet.

4. Enter the IP address information:
Вариант Описание

Один IP-адрес Enter the necessary IP address in x.x.x.x format.

Диапазон IP-адресов Enter the address in x.x.x.x format and specify
the subnet mask.

5. Введите Имя.
6. Необязательно: Введите описание.
7. Щелкните Сохранить изменения.

Ссылки, связанные с данной
Add IQ Bot cloud server IP addresses to allowed list
To ensure seamless connectivity of your IQ Bot cloud servers with the Cloud Control Room, specify a list or
range of IP addresses that are allowed to access the Cloud Control Room URL.
Add Automation 360 Cloud URLs to trusted list
To ensure secure access to Automation 360 cloud services, add the URL specific to the service to the safe
recipients or trusted list.

Set callback URLs
You can specify valid callback URLs, enabling the Control Room to post the results of the task execution
only to defined and secure URLs for more granular security over the network.
Ensure that you are logged in to the  as the administrator.
As a Control Room administrator, you can configure and audit specific, permitted URLs for more granular
control of the network access points. Only the Callback URLs can be used in бот deployment APIs.
1. Navigate to Administration > Settings > Network settings > Deployment settings >

Callback URL.
2. Click the Edit icon. ( )
3. Add the required URLs.

Use the Add option for more URL fields.
4. Щелкните Сохранить.
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Настройка аутентификации SAML
Switch an authenticated environment Control Room database to a SAML identity provider (IdP).

Прим.:  Интеграция SAML необратима. After it has been established, you cannot modify the
configuration.

Ensure that you are logged in to the  as the administrator.
Before you set up authentication for the Control Room, setup tasks (such as introducing credentials on
a new system and importing users) might be required. If you import users, then you must also include
matching user IDs, email addresses, first and last names, in both the Automation Anywhere credentials
and matching records to log in after the SAML integration. For example, if using Okta as a SSO, then users
must have matching IDs, email addresses, first name and last names in both Automation Anywhere and
Okta to log in after the SAML integration.
You should have the required user information and certificate ready. Typical user information consists of
user ID, first and last name, and an email address.

Прим.:  You must validate the SAML IdP setup before you configure the Control Room. См. раздел
Configure the Control Room as a service provider.

After switching to SAML authentication environments, any users with non-SAML IdP formatted IDs will not
be able to log in. You need to verify that any боты located in their private folders are exported so they can
be imported back against their new user accounts.
Much of this configuration relies on third-party applications to create the necessary metadata. If
you require more specific configuration information based on a specific provider, see Configure SSO
authentication with Okta.
To switch the Control Room to a SAML-authenticated environment, follow these steps.
1. Navigate to Administration > Settings > User authentication.
2. Выберите параметр Использовать SAML.

Прим.:  По умолчанию выбран параметр Использовать базу данных Control Room.

3. В поле Уникальный идентификатор объекта для Control Room (поставщика услуг)
введите идентификатор объекта.

4. В поле Зашифровать утверждения SAML выберите один из указанных ниже параметров.
Опция Описание

Не шифровать Утверждения SAML не шифруются.

Зашифровать Утверждения SAML шифруются.

5. Необязательно: Введите значения Открытый ключ и Закрытый ключ.

Прим.:  Вводите ключи только в том случае, если вам требуются зашифрованные утверждения
SAML.

6. Щелкните Проверьте настройки SAML.
The Control Room will log in through the SAML provider and redirect back to the Control Room User
Authentication page.
Если щелкнуть по этому параметру, вы будете перенаправлены на веб-страницу поставщика
услуг SAML 2.0, где вам будет предложено ввести учетные данные и другую информацию.

7. Log in to your provider when prompted.
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8. Щелкните Сохранить изменения.

Задачи, связанные с данной
Configure the Control Room as a service provider
A valid SAML IDP setup must be configured before the Control Room can be switched to a SAML-
authentication environment.

Двухфакторная аутентификация
Двухфакторная аутентификация (2FA) обеспечивает дополнительный уровень защиты от
неавторизованных пользователей к Control Room. Как администратор, вы можете настроить 2FA так,
чтобы пользователи могли подтверждать свою личность при входе в Control Room, используя как
свои учетные данные, так и второй фактор аутентификации.

Как работает 2FA

2FA — это дополнительный механизм аутентификации, добавляемый к процессу входа в систему.
По умолчанию эта функция отключена. Администратор Control Room настраивает 2FA для всех
пользователей или только для тех из них, у кого есть определенные функции. Как только функция
2FA включена, она применяется ко всем пользователям Control Room, для которых она настроена.
Когда вам назначается функция, требующая 2FA, вы должны настроить приложение для
аутентификации на своем мобильном или другом устройстве и установить соединение между этим
приложением и Control Room. При последующих входах в систему вам будет предложено ввести
не только имя пользователя и пароль, но и одноразовый пароль на основе времени (TOTP) из
приложения для аутентификации, чтобы завершить вход в Control Room.

Прим.:  2FA is not supported for Control Room setup using Active Directory (AD) or SSO. 2FA is supported
only when the Control Room is the authentication provider.

Компоненты

В 2FA используются три основных компонента.
• Приложение для аутентификации. Это приложение устанавливается на вашем мобильном

устройстве и генерирует пароли TOTP для проверки вашей личности. Допускаются любые
приложения для аутентификации, поддерживающие протокол TOTP, например DUO или Google
Authenticator.

• Зарегистрированное устройство. Это мобильное или другое устройство, которое вы
регистрируете в Control Room во время первого входа в систему после настройки 2FA. Пароли
TOTP генерируются через это зарегистрированное устройство, которое требуется для каждого
входа в Control Room. Если зарегистрированное устройство утеряно или недоступно, вы должны
попросить администратора Control Room удалить это устройство, чтобы позже у вас была
возможность добавить новое. Поэтому мы рекомендуем вам настроить несколько устройств и
зарегистрировать их на сайте Control Room.

• Одноразовый пароль на основе времени. Это временный пароль, сгенерированный
алгоритмом, который использует текущее время суток в качестве фактора аутентификации.
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Настройка 2FA

1. Включите 2FA в Control Room.
a. Войдите в Control Room как администратор.
b. Navigate to Administration > Settings > Security settings > Two factor authentication.
c. Щелкните Редактировать, чтобы настроить параметры.
d. Выберите Включить. По умолчанию этот параметр не включен.
e. Выберите настройки в соответствии с вашими требованиями.

Вариант Действие

Все пользователи Выберите этот параметр,
чтобы включить 2FA для всех
пользователей, имеющих доступ к
Control Room.
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Вариант Действие

Только пользователи с
определенными функциями

Чтобы включить 2FA для
пользователей с определенными
функциями, выполните указанные
ниже действия.
1. В столбце «Доступные функции»

найдите и выберите функции,
для которых вы хотите включить
2FA.

2. Переместите эти функции в
столбец «Выбрано».

f. Сохраните изменения.

2. Необязательно. Если зарегистрированное (мобильное) устройство пользователя недоступно
или изменилось, удалите устройство и зарегистрируйте новое.
a. Войдите в Control Room как администратор.
b. Перейдите в раздел Администрирование > Пользователи.
c. Выберите пользователя, сведения о котором вы хотите изменить. Наведите курсор на

меню действий (вертикальное многоточие) справа от имени пользователя и щелкните
Просмотреть пользователя.

d. В разделе Аутентификаторы выберите устройство, которое вы хотите удалить, щелкните
по значку удаления и подтвердите действие.

3. Настройте приложение-аутентификатор и установите подключение между ним и Control Room.
a. Войдите в Control Room как пользователь Непрофессиональный разработчик или Bot Creator

(разработчик RPA).
Убедитесь, что на вашем мобильном устройстве установлено приложение-аутентификатор.
Во время первого входа в систему отображается QR-код.

b. Отсканируйте QR-код с помощью приложения-аутентификатора или введите вручную код,
отображаемый в этом приложении.

c. Введите имя вашего аутентификатора и новый код, сгенерированный в
приложении-аутентификаторе.
Это временный код, который обновляется каждые несколько минут на основе данных
вашего приложения-аутентификатора.

d. Щелкните Подтвердить.
Выполните следующие шаги для входу в систему, измените пароль и задайте вопросы
безопасности. Вы успешно войдете в Control Room. При последующих входах в систему
необходимо ввести код, сгенерированный в приложении-аутентификаторе, и подтвердить
его.
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4. Необязательно. Вы можете управлять своим устройством для аутентификации, например
удалить его или добавить снова.
a. Войдите в Control Room как пользователь Непрофессиональный разработчик или Bot Creator

(разработчик RPA).
b. Щелкните по своему имени пользователя на Главной странице.
c. Перейдите в раздел Мои настройки > Двухфакторная аутентификация.
d. Щелкните по значку «плюс».
e. Выполните действия 3.b с помощью 3.d.
f. Необязательно. Выберите устройство, которое вы хотите удалить, щелкните по значку

удаления и подтвердите действие.

Configure Credential Vault Connection mode
Credential Vault is a centralized location for securely storing credential information used by боты.
Configure the Connection mode to connect to the Credential Vault using a Master key.

Прим.:  Provide this key every time you start or restart the Control Room.

To configure settings for Credential Vault, select Express or Manual mode.

Экспресс-режим Auto connect to the Credential Vault with the
master key that is stored in the system during
Control Room configuration.

Ручной режим Use this to manually connect to the Credential Vault
using the master key that was available during
Control Room configuration.

When switching modes, provide the Master Key in the field and click Save for the changes to take effect.

Совет:  Restart the server machine (on which the Control Room is installed) or services to allow changes
to take effect.

All updates to the Credential Vault Connection mode are captured in the Audit Log.
• If you are facing Credential Vault connection issues while accessing the Control Room URL, see CR fails

to load with the Error Code 'cv.validation.secure.cv.locked' (A-People login required).
• If the Credential Vault is configured to connect to the Control Room in Manual mode, and the Master

Key is not added within a certain time period (for example, within 2 minutes), the devices might
disconnect from the Control Room.
Подробнее см. в разделе Bot agent device status remains disconnected post restart of Control Room server
after windows maintenance (A-People login required).

Задачи, связанные с данной
Set up ячейка and assign credentials
Create a role, credentials, and ячейка to share related sensitive values with a group of users, so they can
use those values to build or run боты.
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Editing SQL user information
Edit MS-SQL configuration related settings, including username, password, database server name,
database server IP and port numbers.
To perform the task, you must have a  administrator account with the required rights and permissions.
Download the latest Control Room utility and make certain this utility installed on every sever where
Automation 360 is running.

Прим.:

Users are required to make changes to the running configuration via the command line interface.

Прим.:  Please stop all Automation 360 services on all nodes where a Control Room is installed before
performing this task.

1. Open the command line prompt and navigate to the Automation 360 application.
For example, C:\Program Files\Automation Anywhere\jdk11\bin.

2. Follow the prompts from the utility to select the SQL database and enter the required credentials.

Прим.:  The password will not be displayed on the console

3. Restart the Automation 360 services on the nodes.
The SQL user information has been successfully updated.

Syslog server integration
The Automation Anywhere Control Room supports ingesting tenants' audit log entries in Syslog format to
any Syslog server.

Важное замечание:  The options to specify or modify the Syslog configurations are available only for
the On-Premises deployment.

By pushing syslog data to a Syslog server, you can integrate and leverage the advanced searching and
reporting features of Syslog server solutions. When configured, the Control Room audit logs are forwarded
to both the Transmission Control Protocol (TCP) and User Datagram Protocol (UDP) network protocols. You
can use any syslog server. The following syslog servers are tested and certified by Automation Anywhere:
• Kiwi Syslog Server
• Splunk
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You can configure a Kiwi Syslog Server or a Splunk server that accepts data from a Control Room
instance's syslog through a TCP or UDP port. The following example illustrates sending the Syslog data to
Kiwi Syslog server through TCP or UDP ports.

Configure Kiwi Syslog Server

Solarwinds Kiwi Syslog Server is a widely used commercial Syslog server. Kiwi Syslog Server Free Edition
can monitor Syslog for up to five devices. Download Kiwi Syslog Server Free Edition from the following link:
Kiwi Syslog Server Free Edition. After installation, perform the following steps to configure the Kiwi Syslog
Server:
1. Navigate to File > Setup > Inputs.
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2. To forward the logs through UDP, click UDP.

3. Enter the UDP port and the IP to which you want to forward the logs.
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4. To forward the logs through TCP, click TCP.

5. Enter the TCP port and the IP to which you want to forward the logs.

Configure Control Room to send Syslog on UDP or TCP

To configure the Control Room to send Syslog on UDP or TCP, perform the following steps:

Прим.:
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To perform the task, you must have a  administrator account with the required rights and permissions.

1. Navigate to Administration > Settings > Network settings.

2. Click the Edit icon. ( )
3. To add more Syslog servers, click the plus (+) sign.
4. Введите информацию о сервере Syslog.

Вариант Действие

Имя хоста сервера Syslog Fully qualified domain name (FQDN) or the
IP address of the Syslog server to deliver
the log reports.
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Вариант Действие

Порт Порт, который удаленный сервер Syslog
использует для получения входящих
записей Syslog (например, порт 514).

Протокол TCP или UDP.
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Вариант Действие

Использовать безопасное подключение Для отправки записей Syslog на
удаленный сервер используйте
зашифрованный канал TLS. Этот
параметр доступен только для TCP.

a. To forward the logs to a UDP port, enter the UDP settings (IP, port, and select UDP from
Protocol drop-down).

Прим.:  For information about specific settings, see the Kiwi Syslog Server documentation.
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b. To forward the logs to an TCP port, enter the TCP settings (IP, port, and select TCP from
Protocol drop-down) .

5. Щелкните Сохранить изменения.

Verifying data in the Syslog Server

Reception of logs is verified in the Syslog Server. Perform the following steps to verify the data in Syslog
Server:
1. Generate a Syslog event by logging in or logging out of the Control Room.
2. Verify the logs in the Kiwi Syslog Server.
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If you have configured Splunk Splunk as your Syslog server, then you will observe the syslog messages in
the Splunk.

Редактирование уведомлений по электронной почте
Отредактируйте сведения о сервере электронной почты, который будет использоваться для
отправки уведомлений по электронной почте.
Ensure that you are logged in to the  as the administrator.
Укажите сведения о сервере электронной почты, который вы хотите использовать, и о событиях, при
возникновении которых должны отправляться уведомления по электронной почте. Чтобы настроить
параметры Эл. почты, выполните указанные ниже действия.
1. Navigate to Administration > Settings > Email.
2. Click the Edit icon. ( )
3. Выберите Отправлять уведомления по электронной почте.

По умолчанию уведомления по электронной почте отключены. Вы можете указать, чтобы
подтверждение («Добро пожаловать») созданным/отредактированным пользователям не
отправлялось.
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4. Укажите сведения о сервере, который должен будет использоваться для отправки уведомлений
по электронной почте.
Опция Описание

С этого адреса электронной почты Введите адрес электронной почты, который
должен будет использоваться для отправки
уведомлений по электронной почте.

Узел сервера эл. почты Укажите сервер электронной почты, который
должен будет использоваться для отправки
уведомлений по электронной почте.

Порт сервера эл. почты Укажите порт электронной почты, который
должен будет использоваться для отправки
уведомлений по электронной почте.

Мой сервер использует безопасное
подключение (SSL/TLS)

Выберите этот параметр, если сервер
использует безопасное подключение.

На сервере требуется проверка
подлинности

Выберите этот параметр, если серверу
требуются учетные данные для доступа,
например, для внешнего хранилища учетных
данных.

Укажите Имя пользователя и Пароль,
который должен использоваться для
доступа к серверу.

Укажите учетные данные.

Важное замечание:  Параметры для указания или изменения сведений о сервере электронной
почте доступны только для развертывания On-Premises.

5. Select any or all of the following options to specify the events when an email notification must be
sent:
• Пользователь инициировал процесс «Забыли пароль» на экране входа
• Меняется информация о пользователе, для пользователя
• Пользователь активирован, деактивирован или удален, для пользователя
• TaskBot прекратил работу из-за неудачи, для пользователя, который запустил или

запланировал его
• Пакет BLM экспортирован или импортирован, для пользователя, который

выполнил экспорт или импорт BLM
• A checkin process fails

Важное замечание:  Если параметр Требуется проверка не выбран, на указанный
идентификатор электронной почты отправляется уведомление по электронной почте без
ссылки для подтверждения. Вы можете войти в Control Room без проверки идентификатора
электронной почты и настройки учетных данных для входа.

6. Щелкните Сохранить изменения.

Управление версиями в Automation 360
Управление версиями помогает управлять изменениями, которые вы вносите в файлы, включая
TaskBots, документы, отчеты, сценарии, исполняемые файлы и потоки операций. С помощью
управления версиями можно отслеживать и контролировать изменения в логике вашего бот.
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С помощью управления версиями можно определить версию бот, которую вы хотите изменить, и
сравнить ваши последние изменения с изменениями, сделанными для бот ранее. Обладая правами
администратора Control Room, вы можете настроить управление версиями в настройках Control
Room.
Automation 360 реализует возможности управления версиями, и вы можете использовать эти
возможности независимо от того, интегрирована ли ваша Control Room с Git. Рассмотрите
возможности, доступные в Automation 360 и Git.

Управление версиями в Automation 360

• Выгрузка и загрузка TaskBots. Вы можете выгрузить одну версию бот (версия 1) из общей
рабочей области в свою личную, внести в нее изменения, а затем загрузить бот в общую
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рабочую область. В результате создается новая версия (версия 2) бот, которая является
последней версией. Каждый раз, когда вы выгружаете, вносите изменения и загружаете бот,
новая версия бот создается как последняя версия.

Прим.:  Можно запустить либо последнюю версию бот, либо версию, имеющую метку
«Производство».

Можно выполнить откат к определенной версии бот, выбрав Расширенные параметры в
action «Выгрузить», чтобы выбрать конкретную версию бот для выгрузки. Кроме того, можно
выбрать зависимости для выгрузки. С помощью этого можно вносить изменения в определенную
версию бот и его зависимостей. Когда вы загружаете этот бот, он становится последней версией.
Например, если последней версией бот является версия 8 и вы хотите выполнить откат к
версии 3, необходимо сначала выгрузить версию 3 бот, а затем снова загрузить ее, в результате
чего будет создана версия 9. Эта последняя версия, идентичная версии 3, теперь доступна в
общей рабочей области для операций бот.
Check in a бот | Check out a single бот

• Метка TaskBot. Можно также выполнить откат к определенной версии бот, присвоив метку этой
версии бот. Можно использовать эту метку для выбора версии, с которой вы хотите выполнить
определенные операции бот. С помощью выбранной вами версии вы можете планировать,
выполнять, ставить в очередь, экспортировать и запускать потоки операций разработки бот.
Assign label to a бот

• Просмотр истории TaskBot. Можно просмотреть историю версий ваших TaskBots в общей
рабочей области. С помощью функции Просмотреть историю можно просмотреть историю
изменений, выполненных в ваших TaskBots, и определить actions, выполненные пользователем.
Список всех версий бот отображается в обратном хронологическом порядке. Отображаемая
информация включает номер версии, сообщение о загрузке, дату и время загрузки, а также имя
пользователя, который загрузил версию.
View TaskBot version history

• Сравнение версий. Можно сравнить любые две версии ваших TaskBots, чтобы увидеть различия
между этими двумя версиями.
Compare бот versions

• Восстановление боты из Git. Даже если ваша Control Room не интегрирована с Git, вы можете
восстановить боты из Git в свою общую рабочую область. Например, если у вас 50 боты в вашей
общей рабочей области и 75 боты в Git, вы можете восстановить оставшиеся 25 боты из Git в
общую рабочую область.

Прим.:  This restore option is available only for On-Premises deployments and not supported on Cloud
deployments.

Управление версиями с помощью Git

Если ваша Control Room интегрирована с Git, все версии боты и файлы в Automation 360
синхронизируются с Git, и вы можете использовать указанные ниже дополнительные возможности.
• Интеграция с ветвью Git.
• Интеграция с Git посредством SSH-аутентификации.
• Интеграция с Git посредством прокси-сервера.
• Восстановление боты или файлов в пустой общедоступный репозиторий из существующей

конфигурации Git.
• Настройка force push при подключении к Git.
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Integrating Control Room with Git repositories

Integrating Control Room with Git repositories
Git integration with the Control Room ensures one-to-one mapping of the боты checked in to the public
workspace of the Control Room and the remote Git file structure. Git commits enable you to enforce
security, compliance, and code standards, and ensures that an organization's established best practices can
be applied to their бот development processes.

The Control Room has Git Client that is connected to the Git repository that stores the file history of your
public workspace. Each time a бот developer performs a бот check-in:
• The бот and the dependent files are checked in to the public workspace.
• The Control Room creates a commit that contains all the contents of the particular check-in within the

Git repository.
• The comment entered in the check-in process is used as the Git commit message and the user details

are recorded as the author of the Git commit.
• The Бот definitions are stored as JSON files in the Git repository.

Прим.:  The Git repository must be configured to have write access only to the Control Room and not to
any other Git client.

Supported Git repositories

You can configure the Control Room to replicate the built-in Git repository with the remote Git host, and
synchronize information using Git push. The following sources are certified for Git integration with the
Control Room.
• GitHub
• BitBucket
• Azure DevOps

Configure HTTPS (username and password authentication) between the Control Room and the remote Git
host. The Control Room and remote Git host use standard Git push protocol over HTTPS to send or receive
data.
Exposing the files to your remote Git host enables you to review the бот code and files using third-party
comparisons and static code analysis tools to help enforce compliance and maintain security standards.

Configure a remote Git repository in Control Room
Configure a remote Git repository in the Control Room so that you can version all the боты and their
dependencies and store them in the Git repository. In addition to the local Automation 360 repository in
the Control Room, the remote Git provides a backup for the боты and their dependencies.
• In order to configure a remote Git repository in the Control Room, ensure that you have the

AAE_Admin role.
• Based on your region, configure your network firewall to add outbound NAT gateway IP addresses to

the allowed list.
Automation 360 IP addresses for external integrations

Прим.:
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• The Git repository must be configured to have write access only to the Control Room and not to any
other Git client.

• You cannot upload files greater than 100 MB to the Git repository.

1. In the Control Room, navigate to Administration > Settings > Remote Git repository
integration.

2. Click Edit.
3. Choose one of the following authentication methods and perform the corresponding steps to set up

your Git configuration:
Метод проверки подлинности Шаги

Проверка подлинности HTTPS a. Enter the HTTPS repository path, including the
username in the following format:
https://<username>@bitbucket.org/
companyname/product.git

Прим.:  Use the Git host that you want to obtain the
Git repository address.

b. Enter the branch name.
The changes are pushed to the branch selected. By
default, the master branch is selected.
You can use lower case characters for branch names,
but they must not exceed 250 characters. Do not
include ASCII control characters such as spaces,
tildes, or colons in branch names. You can use hyphen
to separate words. For more information on branch
naming, see Create a new Git branch.

c. Enter your Git repository password or a generated Git
token.

d. Re-enter the password or Git token to confirm.
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Метод проверки подлинности Шаги

Проверка подлинности SSH a. Enter the SSH repository path in the following format:
https://git@bitbucket.org:companyname/
product.git

Прим.:  Use the Git host that you want to obtain the
Git repository address.

b. Enter the branch name.
The changes are pushed to the branch selected. By
default, the master branch is selected.
You can use lower case characters for branch names,
but they must not exceed 250 characters. Do not
include ASCII control characters such as spaces,
tildes, or colons in branch names. You can use hyphen
to separate words. For more information on branch
naming, see Create a new Git branch.

c. Enter your SSH authentication private key.
You must create the private and public key pair by
using the RSA algorithm.

Прим.:  Ensure that the private key entered in the
Control Room contains the following string: -----
BEGIN RSA PRIVATE KEY----- AND -----END
RSA PRIVATE KEY-----

You must generate the public key and enter it in your
Git server.
See the following topics for steps on how to generate
the public key depending on your server:
• Adding a new SSH key to your GitHub account
• Set up an SSH key to your BitBucket account

d. Необязательно. Enter the passphrase.

4. Необязательно: Select the Connect to Git via proxy check box.
a) Enter the proxy host name or IP address.
b) Введите номер порта.
c) Необязательно: Select the authentication check box and enter the user name and password.

5. Click Connect and Save.
The Control Room connects to the remote Git repository, and the following message is displayed: Git
integration settings successfully saved. You can also check the audit log where the
status for Set git settings is displayed as successful.

Прим.:  The check-in operation might take longer if you have many бот files in your Git folder in the
public workspace. This is because an increase in the repository size leads to a slowing down of the git
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commits. As a best practice, we recommend you delete your бот files that are not used from your public
workspace.

You can connect to the same Git repository with a different username in the Control Room. Подробнее см.
в разделе How to change the remote Git repository username in the control room (A-People login required).

See the following video for an overview of Git:

Connect to Azure DevOps Git from Control Room
You can connect to Azure DevOps Git through the Control Room to check in and manage a bot and its
dependent files to the remote Azure DevOps Git repository. It creates a back-up for all your checked-in bot
and its dependent files on Azure DevOps.
• To connect to Azure DevOps Git from Control Room, ensure that you have the AAE_Admin role.
• Make sure that you have an Azure DevOps account.

1. Log in to the Azure DevOps account.
2. Create an Azure DevOps project. Provide a project name and description, select project visibility

(public or private), and then click Create.
3. Click Repos.
4. Click Generate Git Credentials. Enter the username and the password or token. When you obtain a

token to connect to Git, ensure that you have Read and Write permissions.
5. Copy the Git repository path without any changes to Admininistration > Settings > Git

integration > Configuration > Setup Git integration > Edit > Git repository path (including
username) in the Control Room and enter the password/token.

6. Click Connect and Save.
7. To confirm whether your connection is successful, check in a file from the private repository to a public

repository and verify that your changes are pushed to Azure DevOps Git repository.

Remove Git integration configuration
If there is no longer a need to synchronize the бот information stored in your Control Room with the
remote Git host, you can remove or disable it.
Ensure that you have the AAE_Admin role assigned to you.
1. Navigate to Administrators > Settings > Git Integration.
2. In the Git Integration window, click Edit.
3. Select Do not set up Git integration.
4. Click Connect and Save.

This setting removes the remote Git configuration, and the Control Room will no longer push the Git
history to the remote Git host.

Automation 360 IP addresses for external integrations
To ensure seamless connectivity of your Git instance, On-Premises key vault, or SIEM with the Cloud
Control Room, configure your network firewall to include Automation Anywhere outbound Automation 360
IP addresses to the allowed list.
When you configure an Automation 360 Cloud deployment to connect to external systems or to capabilities
such as Git instance, On-Premises key vault, or SIEM with your Cloud Control Room, then you must
provide connections to those systems or services for the Automation 360 Cloud instance.
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The Automation 360 server instance initiates the connection by using one of the listed Automation 360
IP addresses. As a result, you must configure these IP addresses in your network firewall and add the
regional outbound Automation 360 IP addresses to the allowed list.
The following diagram shows a typical Automation 360 Cloud deployment for external integrations:

Based on your region, add the following outbound Automation 360 IP addresses to the allowed list:

Область IP addresses

- Africa • 13.244.57.44
• 13244197159
• 13.244.185.72
• 54.228.5.1
• 54.228.48.30
• 54217103248

- Australia • 54153153175
• 52.65.8.56
• 3106147142

- Canada • 35.203.94.19
• 34.152.28.44
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Область IP addresses

- EU West 1 • 108128188103
• 63.34.200.237
• 52.30.160.238
• 18.197.15.181
• 18.195.27.35
• 3.123.208.13

- EU West 4 • 35204101230
• 34141232185
• 34.141.55.27
• 34.141.57.227

India • 3.7.60.137
• 3.6.235.61
• 13.232.116.48
• 18.136.73.65
• 52.77.203.34
• 18.136.8.15

- Japan • 18177157130
• 18.176.174.19
• 3114196205
• 54.169.202.27
• 52.221.25.42
• 18.140.96.19

- LATAM • 54.94.241.48
• 18.229.39.93
• 52.67.153.170
• 34.195.218.48
• 3.211.67.78
• 3.228.163.41

- Middle East • 15.185.153.52
• 15185181122
• 157.175.32.98
• 52213112204
• 54154112221
• 34.242.58.85

- Sandbox Australia • 34.151.71.179
• 35.189.24.10
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Область IP addresses

- Sandbox EU West • 54.228.82.108
• 54.73.17.42
• 54.228.85.241
• 3.122.33.207
• 35.156.216.8
• 18159235149

- Sandbox US West • 35164189142
• 35166154241
• 35.160.254.91
• 35.168.234.8
• 34204215165
• 54.92.237.118

- Singapore • 18.141.71.43
• 54.251.139.55
• 18136253184
• 18.176.165.62
• 52.68.115.49
• 54168135182

- US Central • 34.85.131.101
• 35245151203
• 34.68.252.217
• 34.123.71.95

- US East • 50.16.245.134
• 35.174.84.76
• 3.210.114.16
• 54.244.136.23
• 54.185.77.190
• 44234224213

- US West • 54213119159
• 34.218.159.79
• 52.33.16.117
• 3.225.222.13
• 34197160162
• 3.213.188.29

- Sandbox US Central • 35.223.219.53
• 34.133.80.165
• 34150165212
• 35245150192
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Область IP addresses

- Sandbox Singapore • 13251176239
• 54.169.33.175
• 46.137.201.87

Restore боты from Git repository
If your database is deleted or corrupted, you can restore all your боты and the associated dependent
files from the Git repository to your new database. This restore option is available only for On-Premises
deployments and not supported on Cloud deployments.
Ensure the following before you restore your боты from Git:
• You must have a backup of the боты on Git.
• You must have the AAE_Admin role assigned.

• The Git restore process requires some downtime. When the restore process is running, the following
public workspace operations are disabled:
• Check-out
• Клонировать…
• Run and schedule боты
• Запуск боты с очередью
• Import and export боты

• When the restore process is running, the check-in operation is not allowed from the private workspace.
However, you can use the private workspace for the rest of the operations.

• You can restore your боты to your empty or non-empty repository.
• You cannot abort an ongoing restore process.

1. Log in to the Control Room as an admin user.
2. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
3. Click the Restore from Git option in the Public workspace.

The Restore from Git dialog box appears, displaying a warning that all the public repository
operations will be disabled during the Git restore process.

4. If you have duplicate files in the Git repository, select to either Overwrite existing files or Skip
existing files in the Git repository.
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5. Based on whether the repository is empty or non-empty, choose one of the following options:
• To restore files to a repository that is not fully empty, enter your Git credentials for the associated

repository.

Прим.:  You cannot use the existing Git configuration for a partially filled repository.

• To restore files to a fully empty repository, you can choose the Git repository from which you want
to restore your files.

Вариант Действие

Использовать существующие параметры
конфигурации Git

Select this option to restore your data from the
Git repository configured with the Control Room.

Прим.:  Ensure you connect your Control
Room to the remote Git repository from
Administration > Settings > Remote Git
repository integration.

Использовать параметры, заданные
вручную

Select this option to restore data from any other
repository.
a. Enter the HTTPS repository path including

the username in the following format:
https://<username>@bitbucket.org/
companyname/product.git

b. Enter the branch name.
c. Enter your Git repository password or a

generated Git token.
d. Re-enter the password or Git token to

confirm.

Прим.:  If you are using the same settings as
the existing Git configuration, you will encounter
an error. To use the same configuration, first
remove the remote Git repository integration
setting in Administration > Settings >
Remote Git repository integration before
providing the same in this manual settings
option.

6. Необязательно: Select the Connect to Git via proxy check box.
a) Enter the proxy host name or IP address.
b) Введите номер порта.
c) Необязательно: Select the authentication check box and enter the user name and password.
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7. Click Continue to proceed with the restore process.
The system starts restoring the боты and the dependent files from Git. This process takes some time.
After the restore process is completed successfully, you are automatically returned to the
Automation page. The боты and the dependent files are restored in your new database, maintaining
the original structure of the dependent files.

If the Git restore process fails after restoring some боты, you are redirected to the public workspace with
the following options. Choose the required option to complete the restore process:

Вариант Действие

Revert restoration bots This option clears all the боты that were
restored.

Прим.:  This option will delete the public боты
that were restored from the Git repository.

Restart restoration The Git restore process restarts from where it
ended.

Keep only the restored files This option retains whatever files were restored
and will exit the restore process.

Статистика использования
Automation Anywhere collects usage statistics from Automation 360 for product improvements.
Usage statistics provides information on where users might be facing issues with the product, the most
used or least used features, and so on. This information helps in product improvement which in turn helps
in improving the customer experience.
By default, the Usage statistics option is enabled in the Control Room and usage data is collected. The
data collected is stored in Automation 360 and the service provider cloud. The collected data is typically
generic information such as anonymized user details, customer name, and user navigation workflows such
as menus the users access and clicks.
An administrator can disable the Usage statistics option by changing the settings in the Control Room.

Прим.:  The option can be disabled only for On-Premises deployments.

Disable usage statistics
An administrator can disable the Usage statistics option by changing the settings in the Control Room.
Ensure that you are logged in to the  as the administrator.
1. Navigate to Administration > Settings > General > Advanced settings.
2. Click the Edit icon. ( )
3. Select the Disabled option.
4. Щелкните Сохранить изменения.

Set up instances for Cloud-enabled deployments
Manage trust relationship between the cloud-deployed Automation 360 Cloud-enabled instance and the
On-Premises applications.
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Ensure that you are logged in to the  as the administrator.
For Cloud-enabled deployment, the initial welcome email that you received from Automation Anywhere
contains:
• URL to the Automation Anywhere Cloud-enabled instance
• Provisioning token needed to establish trust connectivity with the Automation Anywhere Cloud Control

Room

Automation Anywhere deploys and configures an Automation Anywhere Automation 360 Cloud instance for
this Cloud-enabled deployment option. The customer then installs the On-Premises application within their
infrastructure for storing and processing customer data. After this is complete, you install the On-Premises
application within your infrastructure for storing and processing customer data.
1. Log in to the On-Premises Control Room as the administrator.
2. Navigate to Administration > Settings > Cloud-enabled.
3. Provide the provisioning token to connect to the Control Room.
4. Щелкните Сохранить изменения.
5. Необязательно: Test the Cloud-enabled functionality.

Open a browser and enter the URL for the Cloud Control Room service instance. Click Enter to be
redirected to the On-Premises Control Room.

Generate registration key to install Bot Agent in bulk
The Control Room administrator can generate a registration key to install the Bot Agent on multiple devices
at a time in bulk.
Ensure you have set up the Microsoft Active Directory group policy to remotely install the Bot Agent on
multiple devices.
Use Microsoft Active Directory Group Policy to remotely install software

Generate and copy the key for use in an installation script or as part of the Active Directory group policy to
install the Bot Agent on multiple devices at a time.
Also, download the latest Bot Agent MSI installer file to your default downloads path to install the Bot
Agent in bulk.
1. Navigate to Administration > Settings.
2. Select the Bot agent bulk install option.
3. Generate a new registration key for installation.

Прим.:  Before you generate a new key, keep in mind that the new key invalidates the previous key
and any entries or references to the previous key must be replaced with the new key value. Therefore,
we recommend that you generate a new key only if the previous key is compromised.

a) To launch the setting in edit mode, click the Edit option.
When you open this setting for the first time, the option Generate a new key is shown by
default and the phrase Key not set appears.

b) To create a new registration key, select the Generate a new key option.
c) To install the Bot Agent using an installation script or through a Active Directory group policy, click

Copy to clipboard.
d) Сохраните настройки.
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4. Replace the registration key:
a) To launch the setting in edit mode, click the Edit option.

The Keep current key option is displayed by default.
b) To generate a new registration key, select the Generate a new key option.
c) Select Continue on the Current registration key replacement message box.
d) To use the key, click Copy to clipboard.
e) Save the updates.

5. To download the latest Bot Agent MSI installer file, click Download installer.
The Bot Agent installer MSI file is downloaded to your default Downloads folder.

Edit the Bot Agent MSI file to remotely install the Bot Agent on multiple devices.
Задачи, связанные с данной
Bulk install Bot Agent on devices
Installing Bot Agent across multiple devices such as on-premises machines, virtual machines (VM), and
non-persistent virtual desktop infrastructure (VDI) is called Bulk install (or silent install). You must edit the
Bot Agent MSI file for bulk installation.

Edit the Bot Agent installer file
Edit the Bot Agent MSI installer file to add the registration key and Control Room URL to remotely install
the Bot Agent on multiple devices.
To perform the task, you must have a  administrator account with the required rights and permissions.
Ensure the Windows 10 Software Development Kit including Orca and Control Room are installed on your
device. Установить Orca можно из файла C:\Program Files (x86)\Windows Kits\10\bin
\10.0.18362.0\x86\Orca-x86_en-us.msi.
Set up the Microsoft Active Directory group policy to remotely install the Bot Agent on multiple devices.
Use Microsoft Active Directory Group Policy to remotely install software

Edit the Bot Agent.msi file to enable the Control Room administrator to implement the auto-update Bot
Agent policy.
1. Используйте последнюю версию файла AutomationAnywhereBotAgent.msi из указанных

ниже местоположений.
• Загрузите файл из Control Room (Администратор > Настройки > Массовая установка

бот-агента).
Возможность загрузки доступна для развертываний On-Premises и Cloud.

• Выберите файл из папки <путь к файлу приложения>\crui\asset. Например, C:
\Program Files\Automation Anywhere\crui\asset

Эта возможность доступна только для развертываний On-Premises.

2. Edit the AutomationAnywhereBotAgent.msi file using Orca tool.
3. Выберите параметр Свойство.
4. Change the value for AA_CRTOKEN and AA_CRURL.

The AA_CRTOKEN uses the registration key and the AA_CRURL uses the Control Room URL for which
the registration key is generated.

5. Сохраните изменения.

© 2023 Automation Anywhere. All rights reserved.     2781

https://support.microsoft.com/en-us/help/816102/how-to-use-group-policy-to-remotely-install-software-in-windows-server


    Automation Anywhere - Управление

Настройка интеграции с SIEM
The Automation Anywhere Control Room supports security information and event management (SIEM)
tools ingesting logs from your tenant's Audit logs.
With SIEM integration, audit logs can be sent to analytic tools, such as Splunk, Qradar, Sumologic,
and ArcSight. Отправляя записи журнала аудита в инструменты SIEM, можно интегрировать и
использовать расширенные функции поиска и отчетности, реализованные в решениях SIEM.
Журналы аудита Control Room, если это настроено, пересылаются на настроенный сервер SIEM.

Поэтапно настройте сервер SIEM таким образом, чтобы Automation 360 отправлял сообщения аудита
на сервер SIEM. В следующем примере в качестве поставщика SIEM используется Sumo Logic. Для
настройки любого другого сервера SIEM используйте такую же процедуру.

Настройка Sumo Logic
Setup the Sumo Logic as a SIEM tool to collect logs.
Чтобы использовать Sumo Logic в качестве конечной точки ведения журналов, необходимо создать
учетную запись Sumo Logic, добавить новый источник и сохранить URL-адрес источника HTTP.
Чтобы добавить новый источник на веб-сайте Sumo Logic, выполните указанные ниже действия.
1. После создания учетной записи Sumo Logic появится мастер настройки Sumo Logic. Если у

вас уже есть учетная запись, вы можете получить доступ к мастеру, выбрав пункт Мастер
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настройки в меню Управление в верхней части экрана приложения Sumo Logic. In the Setup
Wizard, click Set Up Streaming Data

Появится окно Выбор типа данных.
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2. Щелкните Все другие источники.

Появится окно Настройка коллекции.
3. Щелкните Источник HTTP.

Настроить источник:появляется окно Источник HTTP.
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4. Введите имя в поле Категория источника (например, Http Input) и выберите часовой пояс для
файлов журнала.

5. Click Continue to see a magic url such as the following:https://
endpoint1.collection.us2.sumologic.com/receiver/v1/http/
ZaVnA4dhaV0nFJAEMuwFDGEEZUnDedm7hYhkdUJSAE44bmKKp1mp4LsYDCr2MzTA0C21czkqjz9UVjC1mk4lw512KQ7Usz3OAmNwCMWO09eK9r7h2VZT7B==

6. Сохраните этот URL-адрес в редакторе. Он понадобится при добавлении Sumo Logic в качестве
конечной точки ведения журналов SIEM. Добавление Sumo Logic в качестве конечной точки
ведения журналов SIEM

Добавление Sumo Logic в качестве конечной точки ведения журналов SIEM
To configure the server where audit logs will be sent, add the Sumo Logic as an SIEM logging endpoint.

Прим.:
To perform the task, you must have a  administrator account with the required rights and permissions.
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1. Перейдите в раздел Администрирование > Настройки > Конфигурация интеграции с
SIEM.

2. Click the Edit icon. ( )
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3. Выберите Включено и вставьте Конечную точку сервера SIEM, которую вы скопировали
ранее, из Добавление Sumo Logic в качестве конечной точки ведения журналов SIEM.

Прим.:  Обязательно обратитесь к документации поставщика SIEM, чтобы получить
информацию о заголовках HTTP и требованиях к атрибутам JSON (тело запроса).

4. Выберите HTTP-метод POST, так как Sumo Logic принимает входные данные с использованием
метода POST.

Прим.:  Сертификат инструмента SIEM является необязательным и зависит от поставщика SIEM.
Некоторые поставщики SIEM требуют ввести действующий сертификат инструмента SIEM.
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5. Введите имя для Атрибута события (например, audit). Все сообщения журнала будут
регистрироваться в этой категории и будут служить ключом для поиска всех журналов событий.

Прим.:  Атрибут timestamp является необязательным полем и зависит от сопоставления
поставщика SIEM для этого поля. Например, Splunk требует, чтобы значением было time и
чтобы оно было сопоставлено с одним из полей timestamp. Максимальная допустимая длина
составляет 256 символов. Допускается использование всех специальных символов, кроме
обратной косой черты (\) и двойных кавычек ("). Эти символы должны быть экранированы.

6. Щелкните знак плюс (+), чтобы ввести несколько пар «ключ-значение» для тела
(статические атрибуты), которые будут отправляться вместе с журналами. В парах
«ключ-значение» в качестве входных данных также используются специальные символы. Можно
настроить не более 50 атрибутов.

7. Щелкните знак плюс (+), чтобы ввести несколько пар «ключ-значение» для заголовка
которые будет отправляться с каждым журналом данных о событиях. Данные заголовка
являются специфичными для поставщика SIEM. Например, в Sumo Logic поддерживаются имена
заголовков, начинающиеся с буквы X (например, X-Sumo-Fields). Можно настроить не более
50 заголовков.

Дополнительные сведения о данных заголовка см. в документации соответствующего
поставщика SIEM.

Проверка данных в Sumo Logic
Получение журналов аудита проверяется с помощью веб-интерфейса Sumo Logic. Это можно
сделать, например, посредством поиска событий с использованием имен сборщика и источника
данных.

Для проверки данных в Sumo Logic выполните указанные ниже действия.
1. Создайте журнал аудита, сгенерировав событие. Например, создайте пользователя (Create a

user).
2. Перейдите в Журнал аудита, чтобы просмотреть записи в журналах.

В Sumo Logic вы заметите событие, зарегистрированное в источнике, который вы указали при
настройке Sumo Logic. Настройка Sumo Logic

3. Navigate to Manage Data > Collections
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4. On the Collection tab, click Open in Log Search icon next to the respective log source.

Здесь отображаются события, отфильтрованные по сборщику и источнику. Отображается
событие создания пользователя в формате JSON, отправленное в Sumo Logic по протоколу
HTTPS.

Use AuthConfig App to enable OAuth2 services
As an Organization Administrator with access to CALM (Automation Anywhere app hosted on Salesforce),
you use the AuthConfig App to manage the relationship between a set of Automation 360 Control Room
instances and our OAuth2 (Open Authorization) services.
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Прим.:  The availability of this feature is based on your region.

You use OpenID tokens (issued by Salesforce) to authenticate to the AuthConfig App.

Token overview

Automation Anywhere and the AuthConfig App support the following token types:
• Control Room registration token: The AuthConfig App generates this token which you enter in

the OAuth Settings panel of the Automation 360 Control Room. The Control Room registration token
establishes the identity of your Control Room to the AuthConfig App. After you register and enable the
token, the Control Room can consume access tokens to call APIs.

• Access token: A JSON web token generated from an authorization provider after authenticating with
an Identity Provider (IdP). Access tokens contain claims that provide information to a resource server.
API calls use access tokens to enable an authorized client to gain access to data on the resource server.

• Refresh token: Refresh tokens provide a method to get new access tokens without having to collect
and authenticate credentials every time an access token expires.

The AuthConfig App generates Control Room registration tokens to enable OAuth2 services. The following
diagram shows how a registration token flows between the AuthConfig App and the Automation 360
Control Room:

1. The Administrator uses the AuthConfig App to generate a registration token.
2. The registration token is stored in the database.
3. The Administrator enters the generated registration token into the OAuth Settings in the Automation

360 Control Room.
4. The registration token is stored in the database.
5. The registration token is then sent to the AuthConfig App where if the token matches the token stored

in the database, the Control Room is registered.

Преимущества

You use the AuthConfig App to:
• Enable or disable OAuth2 services for an Automation 360 Control Room (On-Premises or Cloud).
• Configure an Identity Provider (IdP) configuration using a SAML authentication connection for your

organization to use with OAuth2 services.
• Generate registration tokens for each Control Room to securely enable OAuth2 services.
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For details about accessing automations in a web scenario with AARI Extensions and using a custom
widget through Google Chrome extensions, click here.

Предварительные условия

Before you use the AuthConfig App:
• Create your Automation Anywhere community (Apeople) credential: A-People home page (login required).
• From the Automation 360 Control Room:

• To enable an IdP authenticated user to use an access token to call a Control Room API, you must
also add the IdP authenticated user as a Control Room user.

• To use access tokens, you must register and enable Control Room instances with OAuth2 services.

After you complete the prerequisites, you can access the AuthConfig App.

Access the AuthConfig App
The AuthConfig App generates Control Room registration tokens to enable OAuth2 services.
To access the AuthConfig App:
1. Log in to the Automation 360 Control Room as the Administrator.
2. To obtain the AuthConfig App login URL, you can either:

• From the Control Room, navigate to: Administration > Settings > OAuth, and then click the
link provided in the Registration text area, or

• Copy and paste this URL (default URL) into a browser window: https://
oauthconfigapp.automationanywhere.digital

3. The AuthConfig App Log in dialog box displays:

Click Log in to log in with your existing Apeople credentials. You are re-directed to the A-People home
page (login required) page.
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4. From the A-People home page, enter your credentials (username and
password) and click Log in. You are re-directed to the AuthConfig App

page:

From AuthConfig App page, you can:
• Review existing On-Premises and Cloud Control Room instances to enable OAuth2 services
• Configure SAML
• Manage refresh tokens

To log out of the AuthConfig App:
1. Click your username profile at the bottom of the page to open the Log Out dialog box:

2. Click Log Out.

Review Control Rooms
If not already displayed on the AuthConfig App page, select Control Rooms on the left side of the page
to display a list of all your On-Premises and Cloud Control Rooms.
If new Control Room instances were added through CALM (Automation Anywhere App hosted on
Salesforce), click Sync cloud Control Rooms at the top of the page to update and display them in the
list.
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Прим.:  If you delete a Cloud Control Room from the AuthConfig App (which still has a valid license in
Salesforce), then the Cloud Control Room will re-appear in the Control Room list after syncing.

From the Review Control Room page, you can:
• Generate a registration token for a Control Room
• Enable or disable OAuth2 services for a Control Room
• Add or delete an On-Premises Control Room

Generate a registration token for a Control Room

To generate a registration token for a Control Room:
1. Click the Control Room name or hover over the actions menu (three vertical ellipses) located to

the right of the Control Room name and click the Binoculars icon. The Control Room details page
displays.

2. To generate a registration token for the Control Room to enable
OAuth2 services, click Generate token at the top right of the

page:
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3. A confirmation message displays asking if you want to generate the token. The generated token is
required to register your Control Room tenant with OAuth2. Click Generate.

4. A dialog box displays the newly generated registration token. Click Copy token.

Прим.:  You should store this token in a safe place for future use. You cannot retrieve this token after
you close the window.

5. Navigate to: Administration > Settings >

OAuth. In
the text area, paste the token you copied to register the Control Room with our OAuth2 services to
enable using OAuth2 access token.

6. Click Validateand review the data to ensure that it matches the Name and Host URL you were
expecting.

7. Щелкните Сохранить изменения.

This registers the AuthConfig App with the selected Control Room.

Enable or disable OAuth2 services for a Control Room

To enable or disable OAuth2 services for a Control Room:
1. Click the Control Room name or hover over the actions menu (three vertical ellipses) located to

the right of the Control Room name and click the Binoculars icon. The Control Room details page
displays.
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2. By default, the OAuth2 services for a Control Room are disabled. To enable
OAuth2 service, click the Enable OAuth toggle at the top right of the

page:
The OAuth status changes to Enabled.

3. Click < Back to return to the Control Room list.

Add or delete an On-Premises Control Room

Прим.:  You cannot add a Cloud Control Room because it is consumed automatically by the AuthConfig
App.

To add an On-Premises Control Room:
1. Click the Add Control Room icon at the top right of the page:
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2. The Add an On-Premises Control Room dialog box displays:

a. Enter a unique Name and Host URL (for example: https://
digital.automationanywhere.com/nextbank) for the new On-Premises Control Room.
The host URL you enter must match the URL you provided to your external OAuth client (for
example: Pixiebrix).

b. Click Submit when finished.

To delete an On-Premises Control Room:
1. Hover over the actions menu (three vertical ellipses) located to the right of the Control Room name

and click the Delete icon:

2. A confirmation message displays asking if you want to permanently delete the Control Room. Click
Yes, delete to remove the registered Control Room from the AuthConfig App.

Configure SAML connection details
You configure SAML to authenticate to your Identity Provider (IdP) to obtain OAuth access tokens.
To configure SAML connection details:
1. From AuthConfig App page, select SAML Configuration on the left side of the page.
2. Click New SAML configuration at the top of the page.
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3. The New SAML configuration dialog box displays:

a. Enter the connection name and sign-in URL from your external Auth Provider.
b. Enter your Identity Provider's (IdP) public key or click Browse to search for it. The public key

validates the IdP's signed response.
c. Click Create.

The connection name configuration details

display:
The ACS (Assertion Creation Service) URL directs your IdP where to send its SAML response after
authenticating a user, and the Entity ID is the unique identifier of the IdP.
To delete the SAML configuration, click Delete at the top right of the page. A confirmation message
displays asking if you want to delete the SAML configuration.

Прим.:  If you delete the SAML configuration, Control Room users will not be able to obtain new access
tokens using our OAuth2 service.

Click Delete to continue.
Manage refresh tokens
One SAML connection can have multiple tokens.
To manage the refresh tokens:
1. From AuthConfig App page, select Refresh Token on the left

side of the page. The Refresh Token Management page displays:

2. You can enter SAML connection name or subject search parameters in the Search box.
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3. To revoke a refresh token, hover over the actions menu (three vertical ellipses) located to the right of
the token name and click the X (Revoke) icon.

4. A confirmation message displays asking if you want to revoke the token.

Прим.:  By revoking the refresh token, the associated application will not be able to obtain a new
access token using the refresh token.

Click Revoke.

Анализ кода
Анализ кода позволяет оценить программу без выполнения кода. In Automation 360, the code analysis
feature analyzes the code and displays a list of violations based on a set rules. Вы можете просмотреть и
исправить любые ошибки кода или стилистические ошибки для вашей автоматизации.
Анализ кода позволяет сформировать определенные структуры кода, с помощью которых можно
внедрить рекомендации по кодированию и сделать код удобным для обслуживания, надежным,
эффективным и безопасным.

© 2023 Automation Anywhere. All rights reserved.     2798



    Automation Anywhere - Управление

Преимущества

Анализ кода предоставляет вам следующие преимущества:
• Внедрение рекомендаций по кодированию с соблюдением определенных соглашений.
• Предоставление Непрофессиональный разработчик разрешения на добавление новые видов

автоматизации.
• Повышение доступности более сложных видов автоматизации.
• Улучшение читаемости и качества кода.
• Контроль структуры кода автоматизации.
• Improve productivity of the developer and the platform as good coding practise improves the

automation quality over time.

Анализ кода для функций пользователей

Lead RPA Developer (Administrator) Настройка политик анализа кода, определяющих
рекомендации по кодированию в организации.
Мониторинг и составление отчетов о состоянии
качества кода на основе соблюдения этих
политик. Анализ кода позволяет внедрять
определенные практики и принципы
кодирования, которые помогут в следующем:
• Облегчение разработки автоматизаций более

широким кругом сотрудников, например
Непрофессиональный разработчик, которые
могут не обладать развитыми навыками
разработки программного обеспечения.

• Улучшение возможностей обслуживания
автоматизаций за счет снижения сложности
кода и улучшения читабельности.

• Повышение надежности автоматизаций за
счет снижения количества ошибок.

• Повышение безопасности и соответствия
автоматизаций нормативным требованиям
за счет внедрения практик безопасного
кодирования.

• Сокращение времени производства и затрат
на автоматизацию.
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Непрофессиональный разработчик или
разработчик RPA

Анализ кода предоставляет руководство по
разработке автоматизаций, которые отвечают
требованиям организации по следующим
параметрам:
• Сокращение количества ошибок
• Читаемость и обслуживание кода
• Безопасность кода

© 2023 Automation Anywhere. All rights reserved.     2800



    Automation Anywhere - Управление

See the following video for an overview of how code analysis is configured:

Разрешения

Для настройки политики анализа кода вам необходимы перечисленные далее разрешения.
• Просмотреть политики: позволяет просматривать политику анализа кода, которая определяет

способы создания автоматизаций.
• Управлять политиками: позволяет просматривать и редактировать политику анализа кода,

которая определяет способы создания автоматизаций.
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Компоненты

• Редактор политики: содержит глобальную политику для всех пользователей Control Room.
• Правила: основа анализа кода и способ оценки кода бот. Правила могут быть простыми или

сложными в зависимости от выполняемой оценки. Правила включают практики кодирования,
которые можно проверить. Они применяются к пакеты и actions в коде автоматизации. Правило
состоит из уникального RULE_CODE и описания, указывающего характер оценки, которая должна
быть выполнена для этого кода.

Code analysis rules
Rules are the foundation of code analysis. They are used to evaluate the бот logic. Rules can be simple or
complex depending on the evaluation performed. Правила включают практики кодирования, которые
можно проверить. They apply to packages and actions in the automation code.
A rule consists of a unique RULE_CODE and a description which indicates the nature of the evaluation to
be done on the code. You can use the severity levels (low or high) to emphasize the criticality of the rule.
В следующей таблице перечислены правила и их описания, которые можно использовать при
анализе кода.

Код правила Группа Заголовок Описание правила

ACT-GEN-001 Actions, general Action Maximum The number of actions in the
бот cannot exceed the specified
maximum

ACT-GEN-002 Actions, general Try-Catch Coverage All the non-comment actions
within the бот logic must be within
a Try/Catch block.

ACT-GEN-003 Actions, general Infinite Loop
Detection

Mandates the check for infinite
loops in the бот logic

VAR-NMG-001 Variables, naming Variable Name
Pattern

Variable names must match the
specified naming pattern

VAR-NMG-002 Variables, naming Variable Name Length Variable names must be within the
specified minimum and maximum
character length

VAR-USG-001 Variables, usage No Unused Variables All the variables must be used
within the бот

ACT-COM-001 Actions, comments Mandatory Header
Comment

The first action in the бот must be
a Comment action

ACT-COM-002 Actions, comments Comment Coverage The number of Comment actions
must be equal to or greater than
the specified percentage of total
command actions

VAL-HCV-002 Values, hard coded
values

No Hard Coded Delay The delay time in the Delay
action must be set using a variable

VAL-HCV-003 Values, hard coded
values

No Hard Coded File
Path

The file or folder path must be set
using a variable
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Код правила Группа Заголовок Описание правила

VAL-HCV-004 Values, hard coded
values

No Hard Coded Email
Address

The command action field must
not contain a hard-coded email
address

ACT-ERR-001 Actions, error
handling

No Empty Catch The catch block cannot be empty

ACT-ERR-002 Actions, error
handling

Mandatory Catch
Logging

The catch block must contain a
Log to File action

ACT-ERR-003 Actions, error
handling

Mandatory Catch
Screen Capture

The catch block must contain a
Screen capture action

ACT-ERR-004 Actions, error
handling

Mandatory Catch Line
Reference

The catch block error must contain
the reference line number

ACT-LOG-001 Actions, logs Log to file coverage The bot logic must contain the
specified ratio of Log to file
actions

Reviewing code analysis results
As a Bot Creator (RPA developer) or Непрофессиональный разработчик, you can use code analysis to
check and fix any coding errors in your боты. You can develop automation based on configured code
analysis policies and predefined rules.
With code analysis, you can improve the reliability of your боты by implementing coding best practices
such as variable naming conventions, comment coverage, and error handling. Building боты conforming
to the predefined guidelines or rules helps you to identify possible errors during бот development. This
reduces бот failures in the production environment. You can run code analysis in both your private and
public workspaces and view the results.
With code analysis (available from the Bot editor), you get the following benefits:
• Run code analysis as required.
• Get tooltip guidance for compliance with rules
• Integration with Assistant for accounting and guidance.

Code analysis results

To view the results of code analysis, go to the Automation page, and check the Code Analysis results.
This column shows a summary status of the code analysis results for each automation file. The following
details of each status are available:
• N/A: Code analysis does not apply to the object because the object is a folder or is not a бот file.
• Not Scanned: Code analysis has not been run on the бот.
• High severity: The бот has at least one high severity violation.
• Low severity: The бот has at least one low severity violation, but no high severity violations.
• No violations: There are no code analysis violations in the бот.

The following image shows an example result from code analysis:

© 2023 Automation Anywhere. All rights reserved.     2803



    Automation Anywhere - Управление

Прим.:  The status of the боты in the code analysis results column is set to not scanned for the following
scenarios:
• The бот is edited in the private workspace.
• Code analysis is disabled by the administrator or there is a change in any of the rule configuration.

Reviewing results in Bot editor

When you create a бот or modify an existing бот and then save the бот in the Bot editor, code analysis is
initiated in the background, and the results are displayed in the Assistant. The code analysis header shows
the total count of violations in the бот. You can expand the code analysis option, select a specific object
and view the following attributes:
• Applicable object: Displays the бот, variable, action, and action attribute.
• Rule code: Unique RULE_CODE ID.
• Severity: High or low.
• Rule text: Description to indicate the nature of evaluation to be performed on the code.

The following image shows an example of code analysis displayed in the Assistant:
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The code analysis results are displayed in the following order:

Атрибут Rules violated

Бот • Mandatory header comment
• Comment coverage
• Action maximum

Переменная • Variable name pattern
• Variable name length
• Нет неиспользуемых переменных

Действие • No hard-coded delay
• No hard-coded file path
• No hard-coded email address
• No empty catch
• Mandatory catch logging
• Mandatory catch screen capture

The code analysis header displays the count of objects with a violation error within the бот. Each object
can have either low or high severity. The violation is displayed with the attribute followed by the line
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number and the severity. All the high severity errors are displayed first. Navigate to the corresponding line
in the бот that has the violation, rectify the violation, and save the бот.
You must save the бот to see the latest code analysis results in the Assistant.

System-created variables

Variables created by the system such as input or output variables, package-suggested variables, or auto-
generated variables (window variables) use the default variable naming case convention from code analysis
or Pascal case if no format is defined in code analysis rule.

Журнал аудита

When code analysis is initiated either by saving a бот or running code analysis in the Bot editor, the
information is captured in the audit log. The following details are captured:
• Имя Бот
• User information
• The method through which code analysis is initiated (save option or run code analysis option)
• Time taken for the code analysis to run including details such as the number of code lines if captured

by code analysis process
• Total number of violations
• Details of the violations

Code analysis reports
You can access the code analysis report from the Automation page after running code analysis. Отчет
предоставляется в виде загружаемого CSV-файла.
You must have View content permission to download the code analysis results in CSV format.

The report contains the results of the code analysis policy. It details the violation, the location of the
violation, and the бот file location. The code analysis report consists of the following:
• Код правила
• Описание сообщения об ошибке правила (с указанием местоположения из файла бот при

необходимости)
• Местоположение бот
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The following image shows an example code analysis

report:

Configure code analysis policy
As an administrator or a user with view and manage policy permissions, you can configure code analysis
policies to define coding best practices to improve reliability of automations by reducing errors.
Ensure that you have the following permissions:
• Просмотреть политики
• Управлять политиками

1. Войдите в Control Room как администратор.
2. Перейдите в раздел Администрирование > Политики.
3. Щелкните Включено в разделе Статус.

По умолчанию эта функция не включена.
4. Установите одно или несколько правил в разделе Правила.

Прим.:  Вы должны установить хотя бы одно правило, чтобы включить функцию анализа кода.

5. Select the Severity as either Low or High to highlight the criticality of the rule.
После включения политики она применяется глобально ко всем пользователям.
Whenever the policy is updated, a prompt is displayed indicating that the policy is updated, and the
code analysis results page contains details about the боты that have violations.
The following video displays how to configure the code analysis policy:
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Run code analysis
As a Bot Creator (RPA developer) or Непрофессиональный разработчик, you can run code analysis to
evaluate your боты for any coding errors. You can develop automations based on the code analysis policies
and predefined rules.
You must have View content permission to download the code analysis results in CSV format.
• You can run code analysis only on боты that are error-free. If your боты contain errors, the Run Code

Analysis option is not enabled. Resolve the errors in your бот to see the Run Code Analysis option.
• Code analysis automatically runs on all the боты with the Not Scanned status in the public workspace,

thereby providing visibility on the coding best practices for all the боты in the public repository. Code
analysis runs every five minutes and scans 1000 бот files in five minutes.

• Code analysis is not invoked on API бот files.

• Run code analysis in the private workspace:
a) On the Automation page, select the бот, click the actions menu (vertical ellipsis), and click Run

Code Analysis.
A message is displayed indicating that code analysis is successfully completed, along with a file link
with the result of the code analysis.

b) Click the file link to analyze the result of code analysis.
A CSV file with the result of code analysis is displayed.

c) Щелкните Закрыть.

• Run code analysis in the public workspace: Run code analysis by choosing one of the following
options:
Вариант Шаги

Run Code Analysis 1. On the Automation page, select the бот, click the
actions menu (vertical ellipsis), and click Run Code
Analysis.

2. Select the version of the бот for which to run code
analysis:
a. Последняя версия
b. Product label

3. Click Continue.
A message is displayed indicating that code analysis is
successfully completed, along with a file link with the
result of code analysis.

4. Click the file link to analyze the result of code analysis.
A CSV file with the result of code analysis is displayed.

5. Щелкните Закрыть.
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Вариант Шаги

View history Task Bot 1. On the Automation page, select the бот, click
the actions menu (vertical ellipsis), and click View
history Task Bot.
All the versions of the selected бот are displayed on
top showing the latest version.

2. Select a version of the бот, click the actions menu
(vertical ellipsis), and click Run Code Analysis.
A message is displayed indicating that code analysis is
successfully displayed, along with a file link with the
result of code analysis.

3. Click the file link to analyze the result of code analysis.
A CSV file with the result of code analysis is displayed.

4. Щелкните Закрыть.

The following video shows the two ways of running code analysis in the public workspace:

Manage licenses
The Automation Anywhere Control Room provides an automated mechanism for tracking the use of
licensed software across multiple Control Room instances and share these permissions in real-time.

Все лицензии

Automation Anywhere Control Room administrators view, share, and manage user license entitlements
across multiple Control Room instances from a single Control Room. Navigate to Administration >
License to view a summary of product licenses followed by License Summary table.

Прим.:
To perform the task, you must have a  administrator account with the required rights and permissions.

License Cloud services

To edit and or update the license settings, via the License Cloud service, Click Edit license settings and
supply the necessary information on the Edit page.
For more information on this subject, see these resources:
• Лицензии и облачные сервисы
• Управление облачными и файловыми лицензиями
• View and edit Cloud Control Room instances
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License summaries

The License Summary table details the status of all licenses deployed, or available to be deployed, across
any active Control Room. The details displayed are from the point-of-view of the current Control Room to
which you are logged into. This real-time access to license information from multiple deployments across
the network enable a seamless integration for allocation of needed RPA resources as the need arises.

Updating licenses from a server

To add licenses for users, select the desired method of accessing the license by clicking Install license
from server or Install license from file.

Installing additional licenses
Upload new licenses to the Automation Anywhere Control Room to be distributed to users as required.
Ensure that you are logged in to the  as the administrator.
Designate the source of the license (server or filepath) to load into the Control Room. You may also take
advantage of the License Cloud services from this page if enabled. Please see Лицензии и облачные
сервисы for more information.
1. Navigate to Administration > Licenses.
2. Select Install license from server or Install license from file or Edit license settings.

Choose installation source.
Вариант Действие

Install license from server a. Supply the unique Control Room GUID.
b. Click Install license from server.

Install license from file a. Browse to and select the license.
b. Click Install license from file.

Edit license settings a. Enter you unique GUID in the filed provided.

3. Щелкните Сохранить изменения.

Ссылки, связанные с данной
Пользователи
As an administrator, you can create, view, edit, delete, and enable or disable a user. Creating users steps
vary depending on whether the user is a non-Active Directory, Active Directory, or single sign-on (SSO)
user from an IdP server.
System roles
System roles are preconfigured with the permissions necessary to perform the tasks within the scope of
that role. They cannot be modified or deleted. Administrators assign the roles to users to enable them to
access features and perform operations in the Control Room.
Настройки
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Вкладка Настройки позволяет настроить подключение к Credential Vault, включить уведомления по
электронной почте, интегрировать Control Room с репозиторием Git, включить режим безопасной
записи и настроить аутентификацию пользователей.

Stop and start Control Room services on Linux
Review the instructions and service names to stop and restart Automation Anywhere Control Room
services on Linux.
Log in to your Automation Anywhere Control Room server.
1. If you just finished installing A2019, use the following command to display the status of all Control

Room services:
sudo systemctl status control*

Browse through the output. If any of the services are not actively running, you can manually start the
service with the following command (see the next step for specific service names):
sudo systemctl start <servicename>

Прим.:  If more than one service is not running, you can use the script in the next step to start all
the services.

For other Linux installation issues, contact Automation Anywhere support: Open a support case (A-
People login required).

2. Необязательно: Create a script from the following code, such as startallaae.sh, to start all the
Control Room services.
This sample script lists the Control Room services that need to be restarted. You can restart the
services in any sequence.
The sleep commands allow each service to complete startup before the next service is started.

Прим.:  controlroomdiscoverybot.service is only installed by default starting in Automation 360
version 16.

echo Starting elastisearch
sudo systemctl start controlroomelasticsearch.service
sleep 30
echo Starting botcompiler
sudo systemctl start controlroombotcompiler.service
sleep 30
echo Starting control room caching
sudo systemctl start controlroomcaching.service
sleep 30
echo Starting backend service
sudo systemctl start controlroombackend.service
sleep 30
echo Starting reverse proxy
sudo systemctl start controlroomreverseproxy.service
sleep 30
echo Starting messaging
sudo systemctl start controlroommessaging.service
sleep 30
echo Starting iq bot
sudo systemctl start controlroomiqbot.service
sleep 30
echo Starting discovery bot
sudo systemctl start controlroomdiscoverybot.service
sleep 30
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echo Starting aari
sudo systemctl start controlroomaari.service
sleep 30
echo Starting storage
sudo systemctl start controlroomstorage.service
sleep 30
echo Starting ml services
sudo systemctl start controlroomdiscoverybotml.service
sleep 30

Assign execute permission to the script and run it: sudo ./startallaae.sh
3. To stop a single service, use the following command: sudo systemctl stop <servicename>.

Необязательно. To stop all services for maintenance or other requirements, create a script, such as
stopallaae.sh, to stop the Control Room services.

sudo systemctl stop controlroommessaging.service
sudo systemctl stop controlroomreverseproxy.service
sudo systemctl stop controlroombackend.service
sudo systemctl stop controlroomcaching.service
sudo systemctl stop controlroombotcompiler.service
sudo systemctl stop controlroomelasticsearch.service
sudo systemctl stop controlroomiqbot.service
sudo systemctl stop controlroomdiscoverybot.service

sudo systemctl stop controlroomaari.service
sudo systemctl stop controlroomstorage.service
sudo systemctl stop controlroomdiscoverybotml.service

Assign execute permissions to the script and run it: sudo ./stopallaae.sh

Control Room log files
Various types of information about the Control Room are captured in different log files. You can analyze
these log files when the Control Room or a бот encounters an error and identify the root cause for that
error.

Обзор

The log files capture information about the errors encountered by various components of the Control Room
such as the Bot Store, devices, and license. You can use the information in the log files to identify the root
cause of an error and resolve that error.

Log file locations

The Control Room log files are available at C:\ProgramData\AutomationAnywhere\Logs on the
machine on which you have installed the Control Room. The log files are named WebCR_<COMPONENT-
NAME>, for example, WebCR_BotStore, WebCR_Devices, and WebCR_License.
You can refer the following log files for the Control Room.

WebCR.log Contains log entries related to the initialization of
the Control Room and messages, if any.

WebCR_UserManagement.log Contains log entries related to the user
management module.

© 2023 Automation Anywhere. All rights reserved.     2812



    Automation Anywhere - Управление

WebCR_Ignite.log Contains log entries related to the Apache Ignite or
caching system.

WebCR_ServerRepository.log Contains log entries of the server repository related
functions.

WebCR_CredentialVault.log Contains log entries of Credential Vault related
function calls.

WebCR_Hibernate.log Contains log entries related to the Hibernate
system, ORM mapping and Query system, ActiveMQ
messaging subsystem, and so on.

On the Bot Runner machine (on which the Bot Agent is installed), the log files are available at C:
\ProgramData\AutomationAnywhere\BotRunner\Logs. You can refer the following log files for the
Bot Runner machine.

NodeManager.log Contains log entry details of the interaction with the
Bot Agent and the log entry of every message sent
to the Bot Agent.

BotLauncher.log Contains log entry details of the боты that are
deployed on this machine.

TriggerListener.log Contains log entry details of any triggering activities
that occur in боты with triggers.

The corresponding configuration XML files are available at C:\Program Files\Automation
 Anywhere\Bot Agent\config.

Управление рабочей нагрузкой
Модуль управления рабочими нагрузками позволяет пользователям загружать файлы Microsoft Excel
и CSV в Control Room, чтобы записи из этих файлов попадали в развертывания бот.
Эти записи содержат информацию высокой степени конфиденциальности, например, PII, PCI, PHI
и т. д. Эти данные надежно защищены ключом шифрования данных и хранятся в общем файловом
ресурсе и базе данных.
Разделите свои автоматизации на небольшие логические Work Items на странице Рабочая
нагрузка. Process the Work Items simultaneously to ensure that your automation goals are achieved with
optimum resource utilization.

Предварительные условия

Чтобы управлять автоматизацией рабочих нагрузок, убедитесь, что вам назначены указанные ниже
функции и разрешения — все перечисленные или их комбинация.

Тип функции Полномочия

Функции пользователей • AAE_Администрирование_очередей
• AAE_Администрирование_групп
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Тип функции Полномочия

Разрешения на действия • Просмотреть мои выполняемые действия
• Просмотреть моих запланированных ботов
• Запланировать запуск ботов
• Просмотреть и управлять всеми

запланированными действиями из моих
папок

Разрешения устройства • Просмотреть и управлять моими группами
Bot Creator, Bot Runner и устройств

• Создать группы устройств
• Администрировать группы устройств

Разрешения для ботов • Просмотреть мои боты
• Запустить мои боты

Разрешения для рабочей нагрузки • Просмотреть и управлять моими
очередями

• Создать очереди
• Администрировать все очереди

База данных

Автоматизация рабочих нагрузок поддерживается в указанных ниже базах данных.
• SQL
• PostgreSQL
• Oracle

Другие ресурсы

Workflow map: Click the following schematic image to view this workload management workflow in an

interactive visual format:

© 2023 Automation Anywhere. All rights reserved.     2814



    Automation Anywhere - Управление

1. Workload management process

Посмотрите указанное ниже видео о том, как использовать функцию Рабочая нагрузка в Control
Room.
Задачи, связанные с данной
Attach work item template to TaskBot
Attach a work item template to a TaskBot to use the TaskBot in workload automation.
Use Work Item variables
You can use the Work Item variables to pass the Work Item attributes or values to the TaskBot from the
Control Room when you run the бот with the option Run bot with queue.
Ссылки, связанные с данной
Рабочая нагрузка пакет
The Рабочая нагрузка пакет enables you to insert work items in a queue for workload automation. It also
enables data chaining between multiple queues. You can orchestrate multiple боты, and enable optimal
device utilization through the queueing mechanism of workload management.

Создание очередей рабочих нагрузок
A queue is one of the main building blocks of Workload Management. A queue holds data known as Work
Items for further processing. The system distributes these Work Items to individual unattended Bot Runner
in a device pool for processing.
Для автоматизации рабочей нагрузки создавайте и прикрепляйте шаблон рабочей операции к бот,
создавайте группы устройств, добавляйте Bot Runner в группу, создавайте очереди, добавляйте
владельцев, участников или потребителей очереди, определяйте структуру рабочих операций,
вставляйте рабочие операции и, наконец, запускайте автоматизацию с очередью.

Прим.:  In a multi-user environment, if there are two queues A and B, and multiple work items are in
queue A, the device will process work items in queue A first, and then move to queue B. To process both
the queues in parallel in a multi-user environment, you must perform one of the following actions:
• Add another device to the existing device pool.
• Create another device pool on the same device.

Подробнее о задачах, которые можно выполнять, обладая правами владельца, участника или
потребителя очереди, см. в приведенной ниже таблице.

Владельцы Участники Потребители

Могут выполнять
• Просмотр очереди
• Редактирование очереди
• Добавление других

владельцев, участников
или потребителей в
очередь

• Добавление рабочих
операций в очередь

Могут выполнять
• Просмотр очереди
• Добавление рабочих

операций в очередь

Могут выполнять
• Просмотр очереди
• Запуск бота с очередью
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Владельцы Участники Потребители

Не могут выполнять Запуск
бота с очередью

Не могут выполнять Запуск
бота с очередью

Не могут выполнять
Добавление рабочих
операций в очередь

Владельцы и участники очереди Обратите внимание, что владельцы очереди могут
редактировать очередь (изменять имя очереди, описание, добавлять или удалять владельцев,
участников или потребителей), а участники не могут редактировать очередь.
You can create a workload queue in one of the following modes:
• Express mode
• Standard mode

Экспресс-режим

To create queues in express mode with default parameters for workload automation in the Control Room.
For more information, see Create express queues using default workload parameters.

Standard mode

The following diagram describes the flow in which you can create a workload queue in standard mode.

To create a workload queue in standard mode,
1. Создать очереди

Create queues that hold specific sets of data your бот is expecting for automation. To create queues,
an Control Room administrator assigns the AAE_Queue Admin role with View and manage
my queues, Create queues, Administer all queues, and View my in progress activity
permissions.

2. Добавить владельцев очереди
Add queue owners who can create, edit, and view queues.

3. Add participants to queue

Add queue participants from different roles defined in the Control Room. This is an optional step.
4. Add consumers of queues

Add queue consumers from different roles defined in the Control Room. This is an optional step.
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5. Define Work Item structure

Define the Work Item structure for processing in a queue. This enables you to manually upload the
Work Items from the system in the absence of ready data in a file.

6. Insert Work Items

Add Work Items from an Excel or CSV file to the queue after you define the structure.

Задачи, связанные с данной
Запуск бот с очередью
Совместная обработка всех рабочих операций очереди на всех Bot Runner, присутствующих в одной
или нескольких группах устройств.
Attach work item template to TaskBot
Attach a work item template to a TaskBot to use the TaskBot in workload automation.

Create express queues
Create queues with default parameters for workload automation using the express queue option in the
Control Room.
Ensure that you are logged in to the  as the administrator.
You must have the Create queues permission to create queues using the express mode.
When you create a queue with default parameters, note the following:
• All .CSV file columns will be available in a workload бот.
• The first 10 columns of the .CSV file will be displayed in the queue.
• All data type will be text.
• Queue sorting will not be available.

1. Navigate to Manage > Queues.
2. To create queues with default workload parameters, click Create express queue.
3. Enter the queue name.

The queue name is the same as the workitem template name by default.
4. Необязательно: Enter the queue description.
5. To select a data file in .csv format, click Browse.
6. Click Create.

The queue is saved and available for workload automation in the Queues list.
You can now view queue details, edit a queue, and run a бот with queue.

Задачи, связанные с данной
View queue details
Use the View queues details page to view the details of a particular queue.
Редактирование очередей
Редактирование очереди осуществляется двумя способами — в списке Очереди или на странице
Просмотреть очередь.
Запуск бот с очередью
Совместная обработка всех рабочих операций очереди на всех Bot Runner, присутствующих в одной
или нескольких группах устройств.

© 2023 Automation Anywhere. All rights reserved.     2817



    Automation Anywhere - Управление

Создать очереди
Create queues that hold specific sets of data your бот is expecting for automation. To create queues, an
Control Room administrator assigns the AAE_Queue Admin role with View and manage my queues,
Create queues, Administer all queues, and View my in progress activity permissions.
Ensure that you are logged in to the  as the administrator.
A queue is processed until all work items are completed. When new work items are added to the queue,
the Reactivation Threshold value specifies the minimum number of new work items required to resume
queue processing. Work items are those items with a Ready to Run status.
Create a queue by providing details such as the queue name, queue owners, participants, consumers,
work item structure, and auto-retry for failed work items.

Прим.:  You can choose to Create draft of queue and add the remaining information later.

1. Navigate to Manage > Queues.
2. Click Create queue.
3. Введите Имя.
4. Необязательно: Введите описание.
5. Set the Reactivation Threshold to resume queue processing.

Default threshold is 1 (one).
6. Необязательно: Select the average Time required for a person to complete one work item:

• seconds
• minutes
• hours
• days

7. To process the failed work items, specify the Max auto retry attempt.
The failed work items are processed for the specified number of times after all the work items in a
queue are processed.
The default value of Max auto retry attempt is 0 which means the auto retry is not attempted by
default. The maximum Max auto retry attempt value is 10.

Прим.:  The failed work items are processed at the end of the staging queue for auto retry.

Based on the specified Max auto retry attempt number, the Queues page shows the remaining
auto-retry attempts in the Retries left column.

8. Щелкните Вперед.

Добавить владельцев очереди
Задачи, связанные с данной
Редактирование очередей
Редактирование очереди осуществляется двумя способами — в списке Очереди или на странице
Просмотреть очередь.
Delete queues
Delete a selected queue, multiple selected queues, or all queues of work items.

Добавить владельцев очереди
Add queue owners who can create, edit, and view queues.
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Ensure that you are logged in to the  as the administrator.
Queue owners are allowed to edit the queue and add new work items to the queue.
The queue creator is the default queue owner and is able to add other Control Room users as queue
owners, if required.
1. Select user(s) from the Available Users list from the Owners tab.
2. Click the right arrow (→) to add your selection.
3. Щелкните Вперед.

Add queue participants

Add participants to queue
Add queue participants from different roles defined in the Control Room. This is an optional step.
Ensure that you are logged in to the  as the administrator.
Participant roles can add new work items and view the queue. However, they are not allowed to edit other
queue properties.
1. Select role(s) from the Available Roles list from the Participants tab.
2. Click the right arrow (→) to add your selection.
3. Щелкните Вперед.

Add consumers of queues

Add consumers of queues
Add queue consumers from different roles defined in the Control Room. This is an optional step.
Ensure that you are logged in to the  as the administrator.
There are certain mandatory checks that are to be done for unattended bots to be deployed from Control
Room to a device:
• The device where the bot is to be deployed should be set as a default device to only the specific bot

runner account.
• Ensure that all necessary privileges have been granted to the Bot Runner.
• Ensure that nobody is signed into the device at the time of бот deployment with the Run As permission

from a different device.
• Ensure that the console is currently inactive on default device.

Queue consumers can view the queue and all the work items in the queue. In addition, they can use this
queue for running боты on Unattended Bot Runners.
1. Select role(s) from the Available Roles list from the Consumers tab.
2. Click the right arrow (→) to add your selection.
3. Щелкните Вперед.

Define Work Item structure

Define Work Item structure
Define the Work Item structure for processing in a queue. This enables you to manually upload the Work
Items from the system in the absence of ready data in a file.
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Define a Work Item structure using any one of the following methods:
1. Using an Excel/CSV file.
2. Using an existing work item template.
3. Вручную

Прим.:  The work flow to process Work Items differs for a queue based on the method that you
choose in the Define Work Item Structure tab.

1. Select a method to add header columns for Work Item processing:
• Use an Excel/CSV file: Add the header columns from an existing Excel or CSV file. You can point

to the Excel spreadsheet or CSV file you are using in one or more TaskBots you will run in this queue.

a. Enter a unique name for the Work Item structure in the Work item template field.
For example, if the queue contains employee information, you can specify the Work item
template as Employee Data.

b. Select a column for inclusion in the Work Item structure from the list of column names. The
columns are defined based on the header rows of the selected Excel or CSV file. A maximum
of ten (10) columns are allowed for selection and viewing in the Control Room.
For example, you can select column headers Employee Name, Employee ID, and Designation.
You can then select the Data Type - Text, Number, or Date for that column. You can also
choose to view these columns being processed in the Activity page.

Прим.:
• The system allows you to filter/sort Work Items on the columns for viewing the Work Item

data in the Control Room.
Actions allowed on view queue page

• When you upload work items from an xls or xlsx file with data type as text, the Excel file
column populated with a date in any format (for example, 8/6/2019) is converted to its
corresponding workload management date format (for example, Sat Jun 08 00:00:00) in
the Control RoomWork Item. However, the same is not applicable to a csv file.

c. Select up to three columns for sorting in an ascending or descending order.
When the system processes the Work Items from the queue, it uses the sort criteria specified
to retrieve the work items in that order. For example, to process payslips with first Employee
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ID followed by Employee Name from 1 to n and A to Z, specify Employee ID and Employee
Name in an ascending order.

Прим.:  Work items are processed on sorting order internally. For example, if you add 3 work
items a, c, b to be sorted by name, then on the user interface they will be shown as a, c, b.
However, the work items will be processed as per the sorting order a, b, c.

• Use work item template: Add header columns by searching for an Existing work item
template or from the Available work item templates.
This allows you to pass the values or attributes from the template to a TaskBot with the help of
Work Item variables when you use the option Run bot with queue.

Совет:  Search for an existing Work Item template when there are a large number of templates
available for selection.

Use Work Item variables
• Manually: Define the Work Item structure manually. You do not have to select from an existing

structure.
a. Type a name for the Work Item structure in the Work item template field.

For example, if the queue contains employee information, add the Work item template as
Employee Data.

b. Add column header names for the Work Item and select the data type for each column: Text,
Number, or Date

c. Select the display and sorting for the columns in the Control Room.
When the system processes the Work Items from the queue, it uses the sort criteria specified
to retrieve the work items in that order. For example, to process payslips with first Employee
ID followed by Employee Name from 1 to n and A to Z, specify Employee ID and Employee
Name in an ascending order.

2. Click Next to add the Work Items.
Insert Work Items

Ссылки, связанные с данной
Work item status and actions
Based on the Work Item status, you can do only certain actions on a Work Item.

Insert Work Items
Add Work Items from an Excel or CSV file to the queue after you define the structure.
Ensure that you are logged in to the  as the administrator.
Add Work Items from an Excel or CSV file to the queue.

Прим.:  When you upload work items from an xls or xlsx file with data type as text, the Excel file column
populated with a date in any format (for example, 8/6/2019) is converted to its corresponding workload
management date format (for example, Sat Jun 08 00:00:00) in the Control Room Work Item. However,
the same is not applicable to a CSV file.

You can also add Work Items later by editing the queue, see Редактирование очередей.
1. Щелкните Обзор.
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2. Select the Excel or CSV file.
3. Необязательно: Select the Disallow duplicates check box.

Прим.:
• Only unique work items from the CSV file are added. If the CSV file contains any duplicate work

items, then the entire CSV file is ignored.
• This option is available only when you create a new queue.

4. Click Create queue.

• Now that you have created a queue, it is now ready for deployment from a бот.

Запуск бот с очередью
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• Manage Work Items of a queue to fix the discrepancies before queue processing and reduce your
automation-related errors.

Управлять Work Items

Запуск бот с очередью
Совместная обработка всех рабочих операций очереди на всех Bot Runner, присутствующих в одной
или нескольких группах устройств.
To run a бот with queue, ensure that you are allocated a combination of any or all of the following roles
and permissions:

Тип функции Полномочия

Функции пользователей • AAE_Администрирование_очередей
• AAE_Администрирование_групп

Разрешения на действия • Просмотреть мои выполняемые действия
• Просмотреть моих запланированных ботов
• Запланировать запуск ботов
• Просмотреть и управлять всеми

запланированными действиями из моих
папок

Разрешения устройства • Просмотреть и управлять моими группами
Bot Creator, Bot Runner и устройств

• Создать группы устройств
• Администрировать группы устройств

Разрешения для ботов • Просмотреть мои боты
• Запустить мои боты

Разрешения для рабочей нагрузки • Просмотреть и управлять моими
очередями

• Создать очереди
• Администрировать все очереди

Чтобы запустить бот с очередью, обратите внимание на указанные ниже сведения.
• Вы можете запускать боты только на необслуживаемых Bot Runner. Нельзя запускать боты на Bot

Runner с сопровождением из Control Room.
• боты должны быть загружены в общедоступную папку для того, чтобы боты получили право на

запуск с очередью.
• Work item sorting is done on the batch added to the queue. For example, if you add 2 batches of work

items a, c, b and a, c, b to be sorted by name, the work items will be processed for queuing as a, b, c
and a, b, c.
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• If you use the same device pool for inserting and processing work items for the same queue, you will
see duplicate entries in the In-progress activity and Historical page. To resolve this issue, use one
device pool to insert work items and a different device pool to process work items in a queue.

Используйте параметр Запустить бот с очередью на любой из указанных ниже страниц.
a. Действия > В процессе выполнения
b. Управление > Запланировано
c. Управление > Устройства
d. Управление > Группы устройств
e. Управление > Очереди

Процедура запуска бот с очередью одинакова на всех этих страницах.
1. Выберите бот для запуска с очередью.

• Последняя версия. Щелкните вкладку Последняя версия, чтобы выбрать последнюю
версию бот.

• Версия с меткой. Щелкните вкладку Рабочая версия, чтобы выбрать версию бот с меткой.

Доступные боты отображаются вместе с любыми входными значениями и зависимостями.
Если для родительского бот выбран вариант «Метка производства», то автоматически
выбираются также соответствующие зависимые боты с меткой производства. Если какие-либо
из зависимых боты не имеют метки производства, выбирается последняя версия бот.

2. Необязательно: Выберите Запуск с правами администратора, если бот содержит действия,
для выполнения которых требуются правами администратора.

3. Выберите очередь, с которой должен запускаться бот.

Прим.:  Ensure the following to see the list of available queues:
• You do not have the AAE_Admin role
• Your role is added to Queue > Consumers
• The бот and queue work item templates are identical

4. Необязательно: Set the queue running time.
a) Click Add running time in the Processing time tab.
b) Select the days from Days of the week field.
c) Enter the Start time and End time.
d) Click Add time to add another time period for the days selected.

You can add up to three time periods which cannot overlap with each other.
e) Click Add running time to add another running time and provide the day and time details.

You can add up to three running times. If the running time is not set, the queue runs for 24
hours.

f) Необязательно: Click Remove running time to delete any running time.
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5. Выберите пользователя Bot Runner из списка Доступные Bot Runner.
Чтобы можно было включить устройство, оно должно быть подключено к Control Room.

Прим.:  Если устройство не отображается в списке, убедитесь, что пользователю,
запускающему боты, назначена роль, предоставляющая доступ к соответствующим
пользователям, от имени которых выполняется задача («Запустить как пользователи»).

6. Необязательно: Выберите параметр для запуска на устройствах, запускающих бот.
If you want to select Bot Runner that are mapped one-on-one with their default (single-user) devices,
select the Run on bot running devices option. This option enables the Work Items to be deployed
only to the user's default device, whereby the security policy does not allow a user to log in to any
other device or when applications for automation are installed on the default device.
If you select this option, ensure that all the default devices are part of the same device pool when you
select from the Device Pool tab.

Совет:  Do not select this option if the run as users (Bot Runner) are configured to use multiple
devices. In that configuration, if any device in the pool is processing an automation, the run as user
can log in to another device, and the work items will be processed on that device. This enables
optimal utilization of licenses (run as user) and devices.

For information on scenarios for choosing бот running devices for run as users, see Considerations for
running a бот.

7. Select Device pools.
Select the pool from the list of available device pools.

8. Необязательно: Click the up or down arrow to set the selected device pools in preferred order.
When a  is deployed, the  selects the first available device based on the order in which you organized
the device pools. If none of the devices are available at the time of deployment, the  is queued.

9. Выберите Приоритет автоматизации на вкладке Общие.
Установите высокий, средний или низкий приоритет в соответствии с вашими требованиями к
оптимизации ресурсов. По умолчанию для разрешения установлено значение «средний».

10. Щелкните Запустить бот с очередью.

Прим.:  If a user who created the WLM automation using the Run bot with queue option is
deleted, the automation is also affected and queues cannot be processed.

The following video demonstrates how to run a bot with queue.

Задачи, связанные с данной
View automation of a queue
Use the View activity in progress page to view the automation details of the selected queue, Pause,
Resume, or Stop the in-progress automation.
Ссылки, связанные с данной
Одновременные развертывания и выполнения бот
Ознакомьтесь с информацией о максимальном количестве одновременных операций развертывания
и выполнения бот для среды On-Premises.

Add TaskBots and dependent files
Add a TaskBot, and review the input values and dependent files for the automation.
1. Navigate to Activity > Scheduled, Bots > My Bots, or Workload > Queues page.
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2. Click Run bot with queue
The Activity > Run bot with queues Create page is displayed.

3. Enter a name for the automation.
4. Необязательно: Введите описание.

For example, you can describe the purpose of running the TaskBot with a queue.
5. Go to the folder that contains the required TaskBot.
6. Select a TaskBot to process in the queue from the list.

• Последняя версия. Щелкните вкладку Последняя версия, чтобы выбрать последнюю
версию бот.

• Production label: Click Production label tab to select the labeled version of the бот.

By default, the Боты folder is selected.

Совет:  Use the search field to find a TaskBot quickly.

The Input values and Dependencies options are displayed at the bottom of the page.
Если для родительского бот выбран вариант «Метка производства», то автоматически
выбираются также соответствующие зависимые боты с меткой производства. Если какие-либо
из зависимых боты не имеют метки производства, выбирается последняя версия бот.

7. Необязательно: Select the Input values check box to add the values of variables to the бот during
runtime.
This is enabled only if the selected TaskBot has Input values.

Прим.:  In workload automation, input to the бот is provided by the workload queue, the input type
variable is not supported in workload automation.

8. Необязательно: Review the list of dependent files, if available.
This list is enabled only if the selected TaskBot has dependencies. The TaskBot dependencies that are
uploaded in the Control Room are available only for review.

9. Click Next to add a queue, Bot Runner and device pool.
Add queue, Bot Runner, and device pool

If the selected TaskBot does not contain a work item template, an error message appears at the top of the
page. The TaskBot also shows an icon to indicate a missing work item template.
Define Work Item structure

Ссылки, связанные с данной
Бот dependencies
Боты dependencies are files and other боты that are required to run that бот successfully.

Add queue, Bot Runner, and device pool
Add a queue, Bot Runner, and device pool to the automation from the Run bot with queue page.
Ensure that you are logged in to the  as the administrator.
Automation processes are queued until the specified Run as user and devices become available. Queuing
permits other automation processes for that specific Run as user until the specified device becomes
available. Any In use queues are shown as disabled in the Available queues list.
You can deploy the automation on the number of users that you choose with the Run as option and not
on the total number of devices available in a device pool. Select only those queues that are not in use.
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Прим.:  You cannot use multiple queues to add Bot Runner.

1. Select a Queue from the Queues list.
The queues for which you have consumer access and same work item template as the selected бот
are listed.

2. Щелкните Вперед.
3. In the Run as tab, from the Available bot runners list, select a Bot Runner.

a) Необязательно: Select the Run on bot running devices option.
If you want to select Bot Runner that are mapped one-on-one to their default (single-user)
devices, select the Run on bot running devices option. This option enables the Work Items to
be deployed only to the user's default device, whereby the security policy does not allow a user to
log in to any other device or when applications for automation are installed on the default device.
If you select this option, ensure that all the default devices are part of the same device pool when
you select from the Device Pool tab in Step 5.

Совет:  Do not select this option if the run as users (Bot Runner) are configured to use multiple
devices. In that configuration, if any device in the pool is processing an automation, the run
as user can log in to another device, and the work items will be processed on that device. This
enables optimal utilization of licenses (run as user) and devices.

For information on scenarios for choosing бот running devices for run as users, see Considerations
for running a бот.

4. Щелкните Вперед.
5. In the Device pool tab, select a Device Pool from the Available device pools list.
6. Click Add.

The queue and device pool are added to the run бот with the queue list.
7. Необязательно: Click Remove to replace the queue or the device.
8. Щелкните Запустить бот с очередью.

The queue status changes to In use on the Queues page.

Понятия, связанные с данным
Considerations for running a бот
There are certain considerations you have to keep in mind when running a бот.

Manage workload queues
For workload maintenance tasks such as view the details of queues to pause, stop, or resume its
automation, edit the queues, manage the work items in the queue, and delete the queues.

Прим.:  In a multi-user environment, if there are two queues A and B, and multiple work items are in
queue A, the device will process work items in queue A first, and then move to queue B. To process both
the queues in parallel in a multi-user environment, you must perform one of the following actions:
• Add another device to the existing device pool.
• Create another device pool on the same device.
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Workload maintenance tasks

For workload automation maintenance, do the following (in any order):

View queue details Use the View queues details page to view the
details of a particular queue.

Редактирование очередей Редактирование очереди осуществляется двумя
способами — в списке Очереди или на странице
Просмотреть очередь.

Delete queues Delete a selected queue, multiple selected queues,
or all queues of work items.

Управлять Work Items Manage Work Items of a queue to fix the
discrepancies before queue processing and reduce
your automation-related errors.

Ссылки, связанные с данной
Actions allowed on view queue page
Use different actions such as sorting, searching, or filtering on the table view of the queues.

View queue details
Use the View queues details page to view the details of a particular queue.
Ensure that you are logged in to the  as the administrator.
Необходимые разрешения:
1. Queue Owner or Queue Participant or Consumer rights
2. View and manage my Queues feature permission
3. A user with AAE_Admin role can view all the queues and manage (pause, resume, and stop) all the

WLM automations.

Прим.:  If you are not an owner, participant, or consumer of that queue, you can view only queue
names and not the queue details.

The View queues page shows the following queue details:
• New when the work item is added to the queue recently.
• On hold when the work item is deferred from processing by a Queue owner, participant, or consumer.
• Failed when the work item processing failed on an unattended бот.
• Completed when the work item is successfully processed by a Bot Runner or marked Completed by a

queue owner, participant or consumer.
• Data error when there is an error in loading data from the file.
• Active when the work item is currently being processed or staged for processing.
• Ready to run when the work item is successfully processed for execution does not have any data

errors and can be staged for processing.

Queue contents in different tabs such as:
1. Work Items: This is the default view. This allows you to view all work items in a tabulated form. You

can use the filter go view specific work items. For example, all work items with status as Completed.
You can View, Edit, or Delete the individual work items in each row. You can also change the status
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of the work items in bulk. For example, change the status of all the work items in Data error to On
hold.

2. General: View the Reactivation Threshold and Time required to complete one work item.
3. Owners: View the user names of queue owners who can edit the queue and add new work items.
4. Participants: View the user names of queue participants who can add new work items and view the

queue.
5. Consumers: View the user names of consumers who can view the queue and all the work items in

the queue. In addition, they can use this queue when running bots.
6. Work Item Structure: View the work item structure that you defined when creating the queue.

Совет:  Edit any of these details by either clicking the edit this queue link or the Edit button. Also,
delete the queue by clicking the Delete button.

1. Navigate to Manage > Queues.
2. Hover over the Actions icon for the queue.
3. Click View.

View automation of a queue
Понятия, связанные с данным
Управлять Work Items
Manage Work Items of a queue to fix the discrepancies before queue processing and reduce your
automation-related errors.
Задачи, связанные с данной
Создать очереди
Create queues that hold specific sets of data your бот is expecting for automation. To create queues, an
Control Room administrator assigns the AAE_Queue Admin role with View and manage my queues,
Create queues, Administer all queues, and View my in progress activity permissions.
Редактирование очередей
Редактирование очереди осуществляется двумя способами — в списке Очереди или на странице
Просмотреть очередь.
Delete queues
Delete a selected queue, multiple selected queues, or all queues of work items.
Ссылки, связанные с данной
Actions allowed on view queue page
Use different actions such as sorting, searching, or filtering on the table view of the queues.

Редактирование очередей
Редактирование очереди осуществляется двумя способами — в списке Очереди или на странице
Просмотреть очередь.
Ensure that you are logged in to the  as the administrator.
Необходимые разрешения:
1. Функция AAE_Администратор очереди.
2. Права Владельца очереди для редактирования созданных вами очередей.
3. Права Участника очереди для редактирования очередей, созданных другими владельцами

очередей.
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Вы можете редактировать рабочую операцию, только если она находится в состоянии Новая,
Ошибка данных, Приостановлено, Готово к запуску или Неудачно.
Отредактируйте очередь на странице Просмотреть очередь или в списке Очереди.
1. Navigate to Manage > Queues.
2. Hover over the Actions icon for the queue.
3. Click the Edit icon. ( )
4. Click one of the following options to launch the Edit Queue page.

• Ссылка редактировать эту очередь.
• Кнопка Редактировать.

5. Edit the queue details, such as queue name (applicable only if in draft), description, work items,
threshold and time values, auto retry attempt (applicable only if queue is not in use), owners,
participants, and consumers.

Прим.:
• Редактировать структуру рабочей операции после ее определения невозможно.
• When you edit a queue and set new auto retry number, the new number is only applicable to the

new failed work items. If the queue owner changes the auto retry attempt value to a number less
than the existing number, the work item will not be retried.

• Имя очереди должно быть уникальным и не должно использоваться другой очередью.

6. Загрузите файл для рабочей операции, которая будет использоваться для обработки в этой
очереди.
Вкладка Рабочие операции отображается по умолчанию.

Совет:  Вы можете быстро найти рабочую операцию, используя опцию поиска Статус или
Детали статуса.

7. Щелкните Обзор.
8. Выберите файл для загрузки.

Прим.:  Можно загрузить только файл Excel или CSV.
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9. Необязательно: Put work items on hold.
a) Select the work items and click On hold from the table level icons list.

b) In the To update screen, select one of the following options:
• Indefinitely: The work item is put on hold until you manually move it for re-processing.
• Until: The work item is put on hold until the specified date and time. Enter the Date, Time,

and Time zone in their respective fields.
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c) Click Yes, change.
The selected work items are put on hold.

Прим.:  The column On hold until in the Edit queue page displays the work item hold status
(indefinitely or specific date and time). The status of the work items which are not on hold are shown
as N/A.

10. Щелкните Сохранить изменения.
11. Отредактируйте имя и сохраните изменения, внесенные в очередь.

Появится сообщение об успешном редактировании.

Понятия, связанные с данным
Управлять Work Items
Manage Work Items of a queue to fix the discrepancies before queue processing and reduce your
automation-related errors.
Задачи, связанные с данной
Создать очереди
Create queues that hold specific sets of data your бот is expecting for automation. To create queues, an
Control Room administrator assigns the AAE_Queue Admin role with View and manage my queues,
Create queues, Administer all queues, and View my in progress activity permissions.
Ссылки, связанные с данной
Actions allowed on view queue page
Use different actions such as sorting, searching, or filtering on the table view of the queues.

© 2023 Automation Anywhere. All rights reserved.     2832



    Automation Anywhere - Управление

Delete queues
Delete a selected queue, multiple selected queues, or all queues of work items.
You must have the following rights and permissions to complete the task. Ensure you are logged in to the
Control Room as the administrator. To complete the task, you must have AAE_Queue Admin role and
Queue Owner permission assigned to you.

Прим.:  You cannot delete a queue if it is being used for processing a work item. An error message
appears for that particular queue.

1. Войдите в Control Room.
2. Go to Manage → Queues.
3. Use one of the following options to delete selected or multiple queues:

Вариант Шаги

Delete selected queue a. Hover over a queue to delete.
b. Click the Actions menu.
c. Click the Delete button.

A confirmation message to permanently
delete the queue appears.

d. Click Yes, delete to confirm or No, cancel
to discard the action.
A confirmation message appears after you
delete the queue.

Delete multiple selected or all queues a. Select the check box of required queues or
select the check box given in the header to
select all queues.

b. Click the Delete button above the header.
A confirmation message to permanently
delete multiple queues appear.

c. Click Yes, delete to confirm or No, cancel
to discard the action.
A confirmation message appears after you
delete the queue.

Задачи, связанные с данной
View queue details
Use the View queues details page to view the details of a particular queue.
View automation of a queue
Use the View activity in progress page to view the automation details of the selected queue, Pause,
Resume, or Stop the in-progress automation.
Редактирование очередей
Редактирование очереди осуществляется двумя способами — в списке Очереди или на странице
Просмотреть очередь.
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Actions allowed on view queue page
Use different actions such as sorting, searching, or filtering on the table view of the queues.

Searching and filtering

For ease of access, apply search parameters to ID, Start Time, Work item result, Status, and Queue
Name columns.
• Specify the search parameters in the search bar for Queue Name. When you specify search

parameters for the same column, the system searches using OR operator. When you specify search
parameters for different columns, the system searches using AND operator.

• Choose the search parameters from a list in the search bar for Work Item Status.
• Apply filters to Work Item Result to quickly track the final status of the work item. For example if the

work item was completed or skipped.
• Use the Work Item ID to search for specific work items and combine with the Start Time to monitor

the progress of the work items that you search based on the ID. The Start Time filters the list of all
work items that start between two given Start Date and Start Time. For example, all work items
started between 01/08/2021 13:00 hrs. and 31/08/2021 15:00 hrs.

Прим.:  Use a hyphen (-) as separator between IDs as any other symbol gives an error. For example,
100-250.

Table items

The following describes the list of items that can be viewed in the table:

Table Item Описание

Идентификатор Shows the system generated id for a work item.
When a work item is added to a queue, system
generates an id for that work item.

Статус Shows Work item status:
Use the View queues details page to view the
details of a particular queue.

Start Time and End Time Shows the work item's processing start/end time
and date.

Кем изменено Shows the name of the last user who had
modified the work item.

Последнее изменение Shows the time and date when the work item
was modified last.

Прим.:  Apart from the above system generated columns, the fields that you define in your work item are
also displayed as columns.
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Actions on table column

Use the following actions on a table column:
• Click a column to sort it in ascending and descending order. You can sort up to three columns by

holding the Shift key when you click two more columns. This gives you the option of sorting two
additional columns. This way the sorting is done on the entire table and not just the data that is
currently visible to you. The last sorting is stored in memory applied by a user per session.

• Drag a column to the left or right
• Move your mouse cursor at the end of the column and drag to re-size

Actions on work items

Use the following tasks on specific work items:

Table Item Описание

Обновить Allows you to refresh the table contents so that
you can view the latest work item status

Удалить Allows you to delete one or multiple work items.

Пометить как выполнено Allows you to mark one or more work items
as Complete whose status is On hold, Data
Error, or Ready to run.

Новая Allows you to mark one or more work items as
New whose status is On hold, or Data Error

Приостановлено Allows you to mark one or more work items as
On hold whose status is New

Настроить столбцы Allows you to show or hide specific columns. By
default, all columns are displayed including the
ones defined in the work item.

Alternately, select work items and use the following actions. Note that these actions can be performed only
at a table level and not on individual work items.

Table Item Описание

Просмотреть Allows you to view details of selected work item.

Редактировать Allows you to edit details of selected work item.
You can see this icon only if you are the Queue
Owner or Participant or Consumer and the
status of the work item is Unsuccessful, On
hold, or Data error

Удалить Allows you to delete the selected work item.
Note that if a work item is in Active state, you
are not allowed to delete it.

Задачи, связанные с данной
Define Work Item structure
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Define the Work Item structure for processing in a queue. This enables you to manually upload the Work
Items from the system in the absence of ready data in a file.

View automation of a queue
Use the View activity in progress page to view the automation details of the selected queue, Pause,
Resume, or Stop the in-progress automation.
You must have the following rights and permissions to complete the task. Ensure you are logged in to
the Control Room as the administrator. To complete the task, you must have the following permissions
assigned to you:
• AAE_Queue Admin role
• Queue Consumer or Queue Participant rights
• Manage everyone's In progress activity feature permission
• View and manage all scheduled activity from my folders activity permission (if you have access

to the folder which has the WLM бот)
• View and manage all scheduled activity permission (if you do not have access to the folder which

has the WLM бот)

Прим.:
• Though the View automation page is accessible from the Workload module, the page is launched

from the Activity module.
• You cannot Pause/Resume or Stop actions directly from the Activity > In progress page. For these

actions, the Manage > Queues > View automation action is used.

1. Войдите в Control Room.
2. Go to Manage → Queues.
3. Hover over a queue with status In use.
4. Click the Actions menu (vertical ellipsis) and select View automation.

This launches the Activity > Run bot with queue > View page.
5. Choose one of the following options to view automation of a queue:

Параметры Описание

Automation details of the queue • The Бот name, path, dependencies, and if it
requires administrative privileges to run in the
Task Bot tab.

• The Queue used to run the automation in the
Queue tab.

• Bot Runner details such as username, device,
and user status in the Run as tab.

• Details of the device pool in use to run the
automation in the Device pool tab.

• Details such as number of work items that
were active, failed, pending, or completed
processing in the Run history tab.
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Параметры Описание

Приостановить The system pauses the distribution of work items
from this queue to available bot runners in the
device pool.

Прим.:  Until you resume this automation, any
work items with Ready to Run status from this
queue are not sent for processing.

Возобновить The system starts distributing the work items
from this queue.

Остановить • The system stops distributing the work
items from the queue associated with this
automation.

• Select No, cancel to return to the details
page or Yes, stop to stop the work item
processing and return to the Queues page.

Редактирование очередей
Задачи, связанные с данной
View queue details
Use the View queues details page to view the details of a particular queue.
Delete queues
Delete a selected queue, multiple selected queues, or all queues of work items.

Экспортировать очередь
Export queues for flexible usage that ensures efficient processing of WLM automations. With export
queues feature, you can reuse queues across environments such as Dev, QA, and production.
• You must have the AAE_Queue_Admin role to export queues.
• Ensure that the target Control Room user has create users, create roles, and install license permissions.
• The source and target Control Room instances must be running the same version.
• The source and target Control Room instances must be of same setup type: SSO with SSO, AD with AD,

and non-AD with non-AD.
• To receive an email notification on successful export of a queue, ensure that the following notification

is selected in Administration > Settings > Email: A BLM package is exported or imported, to
the user who performed BLM export or import.
For more information see Редактирование уведомлений по электронной почте.

When exporting a queue, consider the following factors:
• You can export only the queues that are in the Not in use state. The queues in the New or Draft state

cannot be exported.
• Before you export a queue, you must pause all the running WLM automations or queues.
• All the queue entities associated with the queue, for example, general settings, owners, participants,

consumers, Work Item structure, and optionally Work Items are exported to your Control Room.

To export a queue, perform the following steps:
1. Navigate to Manage > Queues.
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2. Select the required queue and click Export queues.
3. In the Export queues page, select a queue that you want to export, click the right arrow (→), and

then click Next.
You can select the Include work items option to export work items along with the queues. By
default, the Include work items option is not selected.

Прим.:  When you export a queue along with a large number of work items, the export or import
process might take time up to 30 minutes.

4. In the General section on the left pane, perform the following steps:
a) Обязательно: Specify an Export namefor the queue that you want to export.
b) Необязательно: Specify a password for the exported queue.

If you specify a password, confirm the password in the Confirm password field.

5. Click Export queues.
The selected queue is exported and available in the Activity > Historical page. The exported queue
is in the following file format: Queue Export:Export.Queues.20220715_162251.<<username>>

Прим.:  If Automation 360 is email-enabled and the A BLM package is exported or imported, to
the user who performed BLM export or import. notification in Settings > Email is selected, an
email notification is sent to your registered email ID. The email body contains a link to the Activity >
Historical page to download the exported queue.
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6. Select the queue and click Download exported zip file.

The exported queue zip file is downloaded to your local system, with details such as Queue general
settings, Queue work item template, and Work items (if included during export).

Прим.:  Data such as queue owners, consumers, and participants is not exported.

Импортировать очередь
Import queues for flexible usage that ensures efficient processing of WLM automations. You can also
import queues along with work items.
• You must have the AAE_Queue_Admin role to import queues.
• Users and roles associated with the queues are imported, and the license assigned to the users is also

imported.
• Ensure that the target Control Room user has create users, create roles, and install license permissions.
• Ensure that queue names are unique for importing. Queues with the same name are skipped and not

imported in the target Control Room.
• The source and target Control Room instances must be running the same version.
• The source and target Control Room instances must be of same setup type: SSO with SSO, AD with AD,

and non-AD with non-AD.

When importing a queue, consider the following factors:
• Before you import a queue, you must pause all the running WLM automations or queues.
• Users and roles associated with the queues are imported. Licenses (for example, Bot Creator and Bot

Runner) that are assigned to the users associated with the queues are also imported.
• All the queue entities associated with the queue, for example, general settings, owners, participants,

consumers, Work Item structure, and optionally Work Items are imported to your Control Room.
• When you import Work Items with the queues, the state of the Work Items (Completed, Failed, Data

error, and so on) are maintained in your target Control Room.

To import a queue, perform the following steps:
1. Navigate to Manage > Queues.
2. Select the required queue and click Import queues.
3. In the Import queues page, click Browse to select the required queue from your local system.
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4. Необязательно: Enter a password for the queue that you want to import.
If a queue already exists in your environment, you can select one of the following options:
• Skip the queue (don't import it): The selected queue is skipped and is not imported.
• Make a copy of the queue (a suffix of “copy” will be added to the queue name): A copy

of selected queue is created and imported to your environment, with copy suffixed to the name of
the queue.

5. Click Import queues.
The selected queue is imported and available in the Manage > Queues

page.

Управлять Work Items
Manage Work Items of a queue to fix the discrepancies before queue processing and reduce your
automation-related errors.

Permissions required

You need any of the following permissions to manage the work items:
1. AAE_Queue Admin role
2. View and manage my Queues feature permission
3. Queue Owner, Queue Consumer, and/or Queue Participant permissions

Work item status and actions
Based on the Work Item status, you can do only certain actions on a Work Item.
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Work item - status and actions

The following table provides a description of each Work Item status and the action you can do on a Work
Item having that status:

Work Item Status Описание Действия

Новая New Work Item is added View, Edit, and Delete

Готово к запуску Work Item is successfully
processed for execution

View, Edit, and Delete

Активный Work Item is currently being
processed

Просмотреть

Выполнено Work Item successfully
processed by a Bot Runner

View and Delete

Неудачно Work Item processing has failed
to execute on unattended Bot
Runner

View and Edit

Data Error Data type mismatch when
adding Work Items to the queue

View, Edit, and Delete

Приостановлено Work Item is deferred for use
by the Queue admin

View, Edit, and Delete

Задачи, связанные с данной
Edit work items
Use the Queues page or the Work item page to edit the work items of a queue.
Define Work Item structure
Define the Work Item structure for processing in a queue. This enables you to manually upload the Work
Items from the system in the absence of ready data in a file.

View work items
View work items with a status of Completed, Unsuccessful, On hold, Active, or Data Error in the View
work item page.
Ensure that you are logged in to the  as the administrator.
From the Workload > Queues page, you can perform the following actions on either one queue or
multiple queues, including:
• Удалить. This will delete the work item permanently.
• Mark complete: This will mark the work item as complete.
• Re-process:This will mark the work item in New state.
• On hold: This will mark the work item as On hold.

Прим.:  The Start time and End time are shown when the work item is being processed.

Select a queue to View, Edit, or Delete a queue.
1. Navigate to Manage > Queues.
2. Hover over the Actions icon for the queue.
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3. Click View.

Edit work items

Delete work items

Ссылки, связанные с данной
Work item status and actions
Based on the Work Item status, you can do only certain actions on a Work Item.

Edit work items
Use the Queues page or the Work item page to edit the work items of a queue.
Ensure that you are logged in to the  as the administrator.
You can edit a work item only if it is in a New, On hold, Data error, or Failed state.
1. Navigate to Manage > Queues.
2. Hover over the Actions icon for the queue.
3. Click the Edit icon. ( )
4. Select one of the following options to filter the work items.

• Status
• Id
• Имя
• Work item result

5. Change the work item status to Mark complete, Defer, or Re-process in the Work item
attributes and automation details section.
You can reprocess the failed Work Items by editing and modifying from Failed to Re-process.
The system will set the status to Data Error during the data load if there is any issue with the data.
For example, if a user enters a text value for a number field, or an invalid date string for an attribute
of date type, the status will be displayed as Data Error.
Work item status and actions

6. Щелкните Сохранить изменения.

Delete work items

Delete work items
Delete work items one at a time or in bulk in the View work item page.
Ensure that you are logged in to the  as the administrator.
You can delete a work item only if it is in a Data error, On hold, Ready to run, Complete, or Failed
state. For work items in the Ready to run state, the work item should not be in a queued state. To delete
such work items, Pause the automation.

Прим.:  You can also delete a work item one at a time or in bulk using the Delete option provided above
the Work items table.

1. Navigate to Manage > Queues.
2. Select the queue.
3. Hover over the Actions icon for the queue.
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4. Click Delete.
Confirm or cancel.

Ссылки, связанные с данной
Work item status and actions
Based on the Work Item status, you can do only certain actions on a Work Item.

Export work items to CSV file
Export work items to a CSV file for offline audits and records. The CSV file with the exported work items is
available for download in the Activity > Historical page.
• You must have the AAE_Queue_Admin role to export or import work items.
• The source and the target Control Room instances must be running the same version.
• The source and the target Control Room instances must be of the same setup type: SSO with SSO, AD

with AD, and non-AD with non-AD.

You can export selected, filtered, or all work items to a CSV file by using the following options:
• Export checked items
• Export filtered items
• Export all items

1. Navigate to Manage > Queues.
2. Click the required queue and go to the Work items.

A list of available work items is displayed.
3. Click the Export items to CSV icon.

( )
4. Click one of the following required options:

• Export checked items: Exports only the selected work items

Прим.:  You must select items to use this option.

• Export filtered items: Exports only the filtered work items
• Export all items: Exports all the available work items

A message is displayed, informing that the exported CSV file is available in the Activity > Historical
page.
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5. Navigate to the Activity > Historical page and search for exported work items activity.

Прим.:  You can search for a work item activity by the username. The work item activity name is in
the following format: Work items Export:cr-work-items-20220713-104704.csv. You can change the work
item activity name by using File > Save.

6. Select the work item activity and click Download exported CSV file.
The CSV file is downloaded to your local system as a zip file.

Workload guidelines
To optimally use your work items and queues in Automation 360, review the guidelines.

Do's

• Ensure that the queue has at least 2 owners so that there is no deadlock if an owner is deleted or
disabled.

• If work items are added frequently to a queue, set the reactivation threshold to 1 so that when a work
item is added, the work item is added quickly.

• Up to 10 work item columns can be displayed in the Control Room. Use this feature to get maximum
visibility in to your work item data.

• Optimally use work item values that can accept up to 1000 characters, especially for work item result
values.

• To prioritize certain work items, ensure that you sort the work item data when you create queues.
• To insert work items in a loop, use the v3/wlm/workitems API because this API accepts a list of work

items in JSON format.
• Ensure that the time (clocks) in all the machines in a cluster are synchronized. This is important for the

Apache Ignite cache server to function properly.
• Persistent and continual database connectivity is critical for the functioning of workload automation.

Therefore, ensure that you perform a periodic network scan or use tools that can detect or avoid
network issues.

• Apply the pagination filter to retrieve more than 200 work items when you retrieve them using the work
item API.

"page":
                    { 
                    "offset":0,
                    "length":1000
                    }

Don'ts

• To ensure the system works efficiently, do not use the v3/WLM/workitems API in a loop to insert
work items in bulk.

• If the Bot Runner is part of a device pool, do not create local schedules on that Bot Runner so that the
Bot Runner runs only the work items.

• If a user has a queue in use, do not remove the Run bot permission from that user (role).
• If a work item is in progress, do not shut down a Bot Runner.

To take a Bot Runner offline for maintenance, ensure that you pause the queue and verify no work item
is in progress on the Bot Runner.
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• If a work item queue is being processed, do not stop or restart the Automation Anywhere Control Room
Service. Instead, pause the queue automation, and then restart the service.

Working with repositories, credentials and roles
Control room administrators configure repositories for Bot Creator to develop RPA боты. Administrators
create roles, assign users, and grants permission to action packages used in creating боты.
This topic is intended for experienced Automation Anywhere Automation 360 users.

Administrator tasks

Control room administrators setup repositories for Bot Creator to develop боты. For this process,
administrators create users and assign these users specific roles, such as Bot Creator or Bot Runner. Bot
Creator are granted access to specific RPA action packages to create, test, and run боты. Completed боты
are transferred to the public repository for other users to deploy. The following is a breakdown of control
room administrator related tasks to complete this process.

Set up your bot repository Administrators create repositories for Bot Creator to
develop , test, and debug боты. After configuring
the repository, the administrator creates the role for
the Bot Creator.

Assign a role Roles grant specific permissions to users, such as
Bot Creator and Bot Runner.

Create your users and assign their licensed roles Create or otherwise edit the user information to
assign the licensed role for accessing repositories,
packages, and бот building tools and functionality.

Add пакеты to the Control Room Administrators can add packages to the Control
Room for use by Bot Creator.

Set up lockers and credentials in Credential Vault The credentials assigned are typically those
where the administrator is granting some internal,
business-related access to a Bot Creator or Bot
Runner for RPA development, for example to a
Salesforce account.

Bot Creator task

Bot Creator often require access to protected data to automate a process. Each Bot Creator is given
credentials governing the data they are permitted to access. The administrator creates the credential and
assigns it to individual users by configuring specific roles for the Bot Creator to access those credentials.
Bot Creator must add their own specific attributes to the credentials after they have been assigned by the
administrator.

Manage user credentials
Bot Creator and Bot Runner rely on credentials to access necessary data relevant to the бот building
process.
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Эта задача выполняется пользователем, который хочет создать и развернуть . Для выполнения этой
задачи вы должны обладать необходимыми правами и разрешениями, а также вам должен быть
разрешен доступ в  в качестве лицензированного пользователя.
Bot Creator often require access to protected data to automate a process. Each Bot Creator is given
credentials governing the data they are permitted to access.

Прим.:  Administrators are required to have created the necessary roles and entitlements assigned to the
user in order to update and use any granted permissions.

1. Navigate to Bots > Credentials > My Credentials.
Select the credential to view and or manage.

2. Click Edit.
The configurable fields for the credential are displayed, based on the user granted permissions.
For example, a бот is built that requires the authentication username and password to log in to a
specific URL. The user will create a custom credential for this operation by amending the credential
governed by the administrator, adding the additional security details. This way, the Bot Creator can
authorize only that protected data deemed necessary for the automation.

3. Щелкните Сохранить изменения.

Set up your bot repository
Administrators create repositories for Bot Creator to develop and build боты.
Ensure that you are logged in to the  as the administrator.
Administrators create repositories for Bot Creator to develop , test, and debug боты. After configuring the
repository, the administrator creates the role for the Bot Creator.
1. Log in to the  as the administrator.
2. На левой панели щелкните Автоматизация.
3. Click Create subfolder.
4. Provide the repository folder name and navigation path.

This repository folder is where the боты created by Bot Creator will be stored.

Important:  Based on limits requirement in the Windows operating system (primarily Windows
Server 2019 and 2016), ensure your folder, file names, and the nested folder structure is not long;
otherwise, your бот execution or repository backup can be impacted.

5. Щелкните Создать папку.

Create roles for users. Roles grant specific permissions to users, such as Bot Creator and Bot Runner.

Create your users and assign their licensed roles
Create a user and assign their specific license based role.
Ensure that you are logged in to the  as the administrator.
Create or otherwise edit the user information to assign the licensed role for accessing repositories,
packages, and бот building tools and functionality.
1. Перейдите в раздел Администрирование > Пользователи.
2. Щелкните Создать пользователя.
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3. Enter the required general details as follows:

Поле Значение

Включить пользователя Select for the user to be activated and log in
immediately.

Прим.:  If this option is not selected, user will
be in the inactive state and cannot log in.

Имя пользователя Введите уникальное имя пользователя.

Описание Введите описание пользователя.

Имя Enter the first name for the user.

Прим.:  The number of characters allowed in the
First name field is 50.

Фамилия Enter the last name for the user.

Прим.:  The number of characters allowed in the
Last name field is 50.

Пароль Enter and confirm a password for the user.
Ensure that the password follows all the
necessary password policies.

Эл. почта Введите и подтвердите адрес электронной
почты пользователя.
If SMTP is enabled, an email is sent to this
address to confirm the account. All important
Control Room notifications are sent to this email
address.

4. Select the required role from the list of Available roles.
5. Click the right arrow (→) to add your selection.
6. Select Allow to allow multiple sessions.

You must be Control Room administrator to set a user as a multi-login service user. It is possible to set
a user as a multi-login user either in the UI or API, however a user may only access multiple sessions
through the API.

7. Assign the device Bot Creator license to the user.
The Bot Creator license enables user to create and run боты. Auto login is enabled by default.

Прим.:  When you logged in as administrator, you cannot allocate any device license to the user and
None option is selected by default.

Лицензия Privilege

Нет The user can access the Control Room only.

Bot Creator- Development license Enables user to create and run боты. Auto login
is enabled by default.
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Лицензия Privilege

Unattended Bot Runner - Run-time license Пользователи с этой лицензией могут
выполнять все задачи автоматизации, которые
доступны пользователям с сопровождением.
Кроме того, эта лицензия может быть
использована для развертывания Control
Room, централизованного планирования и
развертывания на основе API.

Attended Bot Runner - Run-time license Users with this license can run боты on their
devices and use any event trigger associated with
their user account or role. However, these users
cannot schedule боты.

Непрофессиональный разработчик -
Development license

Пользователи с этой лицензией могут
создавать и запускать боты (включая боты с
триггерами) на своих устройствах.

The Bypass legal disclaimer option is automatically enabled to allow the user to run боты on a
device without having to manually acknowledge a disclaimer.
After you select a device license, the Device login credentials are enabled. If you have the Attest
device credentials permission, you can choose to attest the device credentials for this user to
bypass credential validation when you deploy боты. The Bot Runner user should have an unlocked
and active user session.

Прим.:  This works only if the auto login setting Reuse an existing session is selected in the
Control Room by the administrator.

8. Щелкните Создать пользователя.

Update the Bot Creator packages and grant permissions to this user to build, test, and run боты. For more
information, see
• Автоматические обновления пакет для On-Premises Control Room
• Automatic пакет updates for Cloud Control Room
• Разрешения на использование для функции
• Бот permissions for a role

Bot Lifecycle Management
The Bot Lifecycle Management feature enables you to move a бот from one environment to another.
For example, you can move a бот from the development or testing environment to the production
environment.

Обзор

Bot Lifecycle Management easily integrates with the DevOps workflow, which supports separate
development, testing, acceptance, and production environments and enables you to move боты along with
their dashboards from one environment to another.
Bot Lifecycle Management provides a framework for continuous testing and deployment of боты and
their dependencies in separate software development life cycle (SDLC) environments, allowing боты to
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seamlessly transition between lifecycle stages defined by an organization before they are released to
production.
You can use the feature to move боты within different environments and help you prevent failure
or disruption of data. You have to export a бот from one environment and then import it to another
environment to move it between environments. You can also bundle all the dependencies of a бот when
transitioning it through the different environments.
The following image shows a typical Bot Lifecycle Management workflow:

What is exported across environments

The following entities are included when you perform an export operation from one Control Room to
another:
• Файлов: Бот
• Dependent files
• Action packages and dependencies
• Информационные панели Bot Insight

The following entities are not included when you perform an export from one Control Room to another:
• Credentials and credential ячейки
• Рабочая нагрузка management queues
• Bot Runner accounts and permissions

Permissions required to export and import боты

To export боты from the Control Room, you must have the following permissions:
• Export bot and View packages feature permissions
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• Check in or Check out folder permissions

To import боты to the Control Room, you must have the following permissions:
• Import bot and Manage package feature permissions
• Check in folder permission

 

Importing Enterprise 11 боты when migrating to Automation 360

You can import your Enterprise 11 боты from the Enterprise 11 Control Room instance to Automation 360.
This method enables you to consolidate the Enterprise 11 боты from multiple Control Room repositories
to a single Automation 360 repository. After importing the боты to Automation 360, use the Bot Migration
Wizard to convert the боты to the Automation 360 supported format (.bot).

Modes to import and export боты

You can use one of the following two modes to import and export боты across different Control Room
instances. Choose a method that best suits your environment and requirements.

Ручной режим Involves exporting and importing боты using the
user interface.
Экспортировать боты | Импорт боты

Automated mode Involves exporting and importing боты using
Control Room APIs.
BLM API

Moving a бот

To move a бот from one environment to another, follow these steps:
1. Export the бот from the Control Room in the source environment.
2. Import the бот into the Control Room in the destination environment.

Guidelines for exporting and importing боты
Review the guidelines before you export or import боты.

Guidelines for exporting боты

• Export the action packages along with the бот because the packages in the target Control Room to
which you are importing the бот might be different.

• Export the боты folder-wise by moving all the боты from one folder first before moving to the next
folder. So do not select the боты from the different folders

• Ensure your SMTP (email) server is integrated with the Control Room so that you can receive a link to
the exported package through email.
Email server settings
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• Ensure that the source and target Control Rooms have the same set of global values.
• Ensure that the source and target Control Rooms have the same set of lockers and credentials that are

referred in the боты.

Guidelines for importing боты

• Рекомендации: When importing бот from the Automation page, use the Skip the bot or file
(don't import it) option because you might want to check the бот first before overwriting it with the
imported бот.

• Recommended:: First import the боты to your private repository (if you are a бот developer), verify
the бот, and then check it in to the public workspace.

• The бот directory path is case-sensitive, so ensure that the export and import paths use the same letter
case in the Control Room.

• Before importing a бот file of size 200 MB or more, check your load balancer configuration. In few
environments, the бот import might fail with an error.

Экспортировать боты
You can export a бот from one Control Room to another.
• Only боты in the public workspace can be exported. To export боты, first check these боты into the

public workspace before exporting them to the private workspace.
• Ensure that you have the View package permissions.
• Ensure that you have the View content rights at the folder level from which you want to export the

боты.
• Убедитесь, что версия Control Room и пакеты в исходном и целевом Control Room одинаковы как

для экспорта, так и для импорта.

Review the guidelines before you export боты.
Guidelines for exporting and importing боты

Recommendation:  To efficiently use the Control Room disk size, as a Control Room administrator, delete
the old export packages from C:\ProgramData\AutomationAnywhere\Server Files\BLM on the
Control Room machine.

1. На левой панели щелкните Автоматизация.
Отобразится список доступных  и форм.

2. Click Export bots icon in the public workspace.
3. Select the бот you want to export.

• Последняя версия. Щелкните вкладку Последняя версия, чтобы выбрать последнюю
версию бот.

• Версия с меткой. Щелкните вкладку Рабочая версия, чтобы выбрать версию бот с меткой.

4. Щелкните Вперед.
The бот and its dependencies are ready for export and displayed in the Review Dependencies
window. Если для родительского бот выбран вариант «Метка производства», то автоматически
выбираются также соответствующие зависимые боты с меткой производства. Если какие-либо
из зависимых боты не имеют метки производства, выбирается последняя версия бот.

5. Щелкните Вперед.
All related пакеты are displayed.
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6. Select the necessary пакеты associated with the бот to export.
Select Exclude bot packages to remove all пакеты from the export.

7. Необязательно: Enter a password in the Create password field.
Password enhances the security for your бот or file when exporting from one Control Room to another.

8. Re-enter the password in the Confirm password field.
9. Click Export bots and files.

All the selected боты are exported into a zip file.
Based on the result (failure or success) of the export бот functionality, a notification is also displayed
in the Control Room Notifications icon. For more information, see Экспортировать бот event
notification.

Прим.:  If you have analytics боты in your Control Room, all the Bot Insight dashboards (default,
custom, and published) associated with the боты are also exported into the zip file.

If you have configured SMTP, an email is sent that contains a link to the zip file of the exported пакет.
If you have not configured SMTP, perform the following steps to access the link to the zip file of the
exported пакет:
a) Navigate to Activity > Historical.
b) Search and view the historical activity of the exported package.
c) Click Download exported zip file.

A link to download the zip file is displayed.

10. Use the link to download the zip file and save it to a location for importing it to another Control Room.

Прим.:  If you are exporting a large size бот or dependency, there might be a delay in the download
of the export zip file from the Activity > Historical page.

Import the боты into an Control Room.
Задачи, связанные с данной
Импорт боты
Вы можете импортировать боты с их зависимостями из одного экземпляра Control Room в другой.
Исходным окружением может быть Automation 360 Control Room, Enterprise 11, or Enterprise
10Экземпляр Control Room.
Ссылки, связанные с данной
System roles
System roles are preconfigured with the permissions necessary to perform the tasks within the scope of
that role. They cannot be modified or deleted. Administrators assign the roles to users to enable them to
access features and perform operations in the Control Room.

Импорт боты
Вы можете импортировать боты с их зависимостями из одного экземпляра Control Room в другой.
Исходным окружением может быть Automation 360 Control Room, Enterprise 11, or Enterprise
10Экземпляр Control Room.
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• Убедитесь, что для импорта боты предоставлены указанные ниже права.
• Разрешение на импорт боты
• Разрешение на создание папки, если требуется
• Разрешение на загрузку в общее рабочее пространство, если вы импортируете в общее

рабочее пространство

• Убедитесь, что версия Control Room и пакеты в исходном и целевом Control Room одинаковы как
для экспорта, так и для импорта.

• Для импорта боты в личную область или общую рабочую область требуется лицензия Bot Creator.
Вы можете импортировать боты в общее рабочее пространство, если у вас есть необходимые
разрешения, независимо от вашей лицензии.

• Чтобы импортировать Enterprise 11 боты в свой экземпляр Automation 360 Control Room, учтите
следующие дополнительные требования.
• You must have the required aapkg package that you created using the Bot Lifecycle Management

export feature in the Enterprise 11 Control Room instance.
• Пакет aapkg должен присутствовать на том же компьютере Automation 360, куда вы хотите

импортировать Enterprise 11 боты.
• You can import the password protected aapkg packages using the Bot Lifecycle Management

Import API only. See Import repository bots in BLM API

• Изучите рекомендации перед импортом боты.
Guidelines for exporting and importing боты

• Для импорта боты из одного экземпляра Control Room в другой, используйте экспортированный
файл zip (или файл aapkg, в случае Enterprise 11 or Enterprise 10боты). Если SMTP настроен, вы
получите ссылку для загрузки файла zip или aapkg на настроенный адрес электронной почты.
Если SMTP не настроен, вы можете получить доступ к ссылке для загрузки, перейдя на страницу
Действия > История.

Прим.:  Вы можете импортировать Enterprise 11 боты (файл .aapkg) с зависимыми MetaBots или
без них только в общее рабочее пространство. Если вы импортируете файл в личное рабочее
пространство, убедитесь, что включены зависимости зависимых MetaBots.

1. На левой панели щелкните Автоматизация.
Отобразится список доступных  и форм.

2. Щелкните Импортировать ботов.
3. Найдите и выберите необходимый файл zip или aapkg в зависимости от исходного окружения.

Исходное окружение Действие

Automation 360 боты Выберите нужный файл zip.

Enterprise 11 or Enterprise 10боты Выберите нужный файл aapkg.
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4. Выберите личное рабочее пространство или общее рабочее пространство в зависимости от
следующего исходного окружения.
Исходное окружение Действие

Automation 360 боты При необходимости можно выбрать личное
или общее рабочее пространство.
Если у вас есть боты аналитики в исходном
окружении Automation 360, то все связанные
информационные панели Bot Insight также
импортируются на основе следующего выбора.
• Если вы выберете личное рабочее

пространство, вы сможете просматривать
только стандартные и пользовательские
информационные панели.
Чтобы просмотреть опубликованные
информационные панели, необходимо
зарегистрировать боты в общем рабочем
пространстве.

• Если вы выберете общее рабочее
пространство, вы сможете просматривать
только опубликованные информационные
панели.
Чтобы просмотреть стандартные и
пользовательские информационные
панели, необходимо выгрузить боты в
личное рабочее пространство.

Enterprise 11 or Enterprise 10боты Выберите общее рабочее пространство.
Этот выбор позволяет вам выполнить
миграцию Enterprise 11 or Enterprise 10боты
в окружение Automation 360 позже во время
миграции.

5. Необязательно: Введите пароль в поле Пароль.
Если ваш экспортированный бот или файл защищен паролем, вам будет предложено ввести
пароль. Получите пароль от пользователя, который экспортировал этот бот или файл.

6. Если некоторые из файлов, импортируемых из пакета, уже доступны в вашем Control Room,
выберите один из следующих вариантов.
• Пропустить бот или файл (не импортировать его)
• Заменить бот или файл импортируемым

7. Щелкните вариант Импортировать ботов.
8. После завершения импорта, в зависимости вашего исходного окружения перейдите в

соответствующий репозиторий, чтобы найти и использовать импортированный бот.
Исходное окружение Действие

Automation 360 боты Перейдите в соответствующее рабочее
пространство (личное или общее, в
зависимости от вашего выбора в шаге 4).
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Исходное окружение Действие

Enterprise 11 or Enterprise 10боты Перейдите в общее рабочее пространство
в папке Bots > My Tasks или Bots > My
Metabots.

Прим.:  Enterprise 11 and Enterprise
10боты импортируются в формате .atmx
и .mbot. Используйте мастер миграции
, чтобы преобразовать файлы Enterprise
11 and Enterprise 10боты в формат .bot,
поддерживаемый в Automation 360.

Миграция корпоративных боты

Задачи, связанные с данной
Экспортировать боты
You can export a бот from one Control Room to another.
Ссылки, связанные с данной
System roles
System roles are preconfigured with the permissions necessary to perform the tasks within the scope of
that role. They cannot be modified or deleted. Administrators assign the roles to users to enable them to
access features and perform operations in the Control Room.

Credentials and ячейки in the Credential Vault
The Credential Vault securely stores sensitive information such as passwords, account numbers, and social
security numbers in credentials and ячейки for use in automation tasks. It facilitates role-based access for
users of a Control Room and ensures that sensitive values are not stored in боты or on devices.
The Credential Vault consists of two main features: credentials and ячейки.
Best Practices:
• Each credential should contain a single password used for authentication to a specific system.
• The credential may have additional attributes such as user name or hostname depending upon what is

required in the authentication process that the credential is used for.
• Credentials for applications that process data which requires the highest confidentiality have the least

number of consumers where credentials for applications that require lower confidentiality can have a
higher number of consumers. Segregate credentials based on applications and data confidentiality.

• Lockers are created to hold credentials that are related to a specific business purpose or class of
application based on confidentiality.

Учетные данные A credential holds the sensitive information in
attributes. An attribute can have a value that is
standard for all users or it can accept a user-input
value. For example, an Email credential can hold
three attributes: host name (standard value),
username (user input), and password (user
input).
По умолчанию все пользователи могут
создавать, использовать собственные учетные
данные, а также управлять ими. A user is granted
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access to another user's credentials by receiving
access to a ячейка that holds the credential. If the
credential requires a user-input value, it appears in
the CREDENTIAL REQUESTS tab.
A credential must be assigned to a ячейка to be
used for building and running a бот.

Ячейки A locker specifies which users can view, modify,
or access the credentials. For example, a human
resources (HR) locker can hold Email, Database,
and Training website credentials and allow
only specific employees of the HR department to
use the credentials in their боты.
A user with either the AAE_Locker Admin role
or a user-created role with the Manage my
credentials and lockers permission configures
ячейки, adds credentials, and grants access to
other users.

Benefits of using the Credential Vault

Apart from providing a secure and centralized location for storing credentials, using the Credential Vault
also:
• Minimizes credential fraud.
• Provides an environment to enable improved security.
• Enables businesses to adhere to the processes and credential management compliance standards.
• Offers increased automation opportunities with secure data applications.

Понятия, связанные с данным
RBAC for Credential Vault credentials management
Credentials created in the Control Room are used across Bot Creator and Bot Runner.
Configure Credential Vault Connection mode
Credential Vault is a centralized location for securely storing credential information used by боты.

Set up lockers and credentials in Credential Vault
Assign credentials to lockers for Bot Creator to access during the бот building process.
Ensure that you are logged in to the  as the administrator.
The credentials assigned are typically those where the administrator is granting some internal, business-
related access to a Bot Creator or Bot Runner for RPA development, for example to a Salesforce account.

Прим.:  Credential and attribute names are not case-sensitive and are stored as "lower-case".

1. Navigate to Manage > Credentials.
2. Click Create credential.
3. Enter the Credential name and a Description for the configured credential or select External key

vault.
If integrating with an external key vault, then proceed to Select External key vault.

4. Enter the Attribute name and supply the Description for the attribute.
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5. Select one of the following Input options:
Ввод Значение

Стандартная Enter the value. All users see the same credential
value set by the credential owner.

Предоставлено пользователем The value field is not available because the
values are not preset during creation. Only users
of the ячейка containing this credential can
provide the value.

6. Set Security for the attribute.

Прим.:  When the Masked option is selected, the attribute value is marked as a password-only
attribute and shown as asterisk (*) characters for security purpose.

7. Click Create credential.
8. Click the MY LOCKERS tab.
9. Click Create locker.
10. Введите Имя.
11. Необязательно: Введите описание.
12. Click Create locker.

Set up ячейка and assign credentials
Create a role, credentials, and ячейка to share related sensitive values with a group of users, so they can
use those values to build or run боты.
Do the following to set up the ячейка and assign credentials:
1. Create a role

Define a role and assign permissions to access various features for building боты.

Прим.:  You must have the AAE_Admin role or the Manage roles permission to create a role and
assign it to users.

2. Создать учетные данные
Create a credential and add the required attributes.

Прим.:  You must have the Manage my credentials and lockers and Create standard
attributes for a credential permission to create a credential and attributes.

3. Создать ячейка
Create a ячейка to group similar credentials and share with other users.

Прим.:  You must have the AAE_Locker Admin role or the Manage my credentials and lockers
permission to create a ячейка and assign users and roles to it.

Понятия, связанные с данным
RBAC for Credential Vault credentials management
Credentials created in the Control Room are used across Bot Creator and Bot Runner.
Задачи, связанные с данной
Edit a credential
Modify credential details and add or remove attributes.
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Edit a locker
Add or remove credentials, owners, managers, participants, or consumer roles.

Создать учетные данные
Create a credential and add the required attributes.
This task is performed by the Automation Anywhere Control Room administrator. You must have the
necessary rights and permissions to complete this task. Ensure you are logged in to the Control Room
as the administrator, or a user with either the AAE_Locker Admin role, or a user-created role with the
Manage my credentials and lockers permission to configure lockers, add credentials, and grants
access to other users.
Assign the credential when adding the credential details. If no ячейка was created, create a ячейка and
then assign the credential. Add up to 50 attributes to a credential.
1. Log in to the Control Room as the administrator.
2. Navigate to Manage > Credentials and click Create credential.
3. Enter the Credential name and a Description for the configured credential or select External key

vault.
If integrating with an external key vault, then proceed to Select External key vault.

4. Enter the Attribute name and supply the Description for the attribute.
5. Select External key vault.

If integrating with an external key vault, such as AWS, Microsoft Azure, or CyberArk, enter the
required credentials for the specified external vault as follows:

AWS Enter the secret name.
CyberArk Enter the object name.
Microsoft Azure Enter the secret name.

6. Select one of the following Input options:
Ввод Значение

Стандартная Enter the value. All users see the same credential
value set by the credential owner.

Предоставлено пользователем The value field is not available because the
values are not preset during creation. Only users
of the ячейка containing this credential can
provide the value.

7. Set Security for the attribute.

Прим.:  When the Masked option is selected, the attribute value is marked as a password-only
attribute and shown as asterisk (*) characters for security purpose.

8. Необязательно: Select Use attribute ONLY on Password or Masked fields.
This option ensures that боты input the attribute value only into fields that are identified as password
fields.

Прим.:  When this option is selected, an attribute is available only for the commands in Automation
Anywhere Enterprise client that support credential variables and where the fields are of Password
type.

9. Click Create credential.
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Assign this credential to a locker.

Edit a credential
Modify credential details and add or remove attributes.
A credential can be edited by the owner when the credential is not assigned to a ячейка. If a credential
input type is user-provided, then ячейка consumers can edit the credential to input a value.
Role-based access and locker permissions

Прим.:  A user with the AAE_Администратор ячейки role can assign a credential to a new owner.
Подробнее см. в разделе Передать право на учетные данные….

1. Navigate to Manage > Credentials.
2. Hover over the Actions icon for the credential.
3. Click the Edit icon. ( )
4. Edit the credential.

If the email notification setting is enabled and credentials are added to a ячейка, then all the ячейка
consumers receive an email.
The maximum limit of credential attributes that is allowed is 50. If you have upgraded to the current
version and have migrated credentials that have more than 50 attributes, when editing that particular
credential, the following message displays: Credentials can only have a maximum of 50
 attributes. To continue, remove the additional attributes that cannot be saved and add those to a
new credential.

5. Щелкните Сохранить изменения.

Ссылки, связанные с данной
Credential Vault email notifications
When the email notification setting is enabled, it ensures that users are notified of any changes to
credentials and lockers.

Передать право на учетные данные…
A user with the AAE_Администратор ячейки role can transfer a credential to a different owner.
A credential can only be reassigned to a different owner if it is in a ячейка. The new owner can be either
the ячейка owner, manager, or participant.
1. Navigate to Manage > Credentials.
2. Use the search bar to find the credential.
3. Hover over the vertical ellipses to the right of the credential.

The actions menu opens.
4. Click Transfer credential ownership.

A list of users with access to the ячейка appears,
5. Select the new credential owner.
6. Click Yes, submit.

Создать ячейка
Create a ячейка to group similar credentials to share with other users.
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You must either have the AAE_Locker Admin role or Manage my credentials and lockers permission
and the necessary permission to View Users and Roles.

Прим.:  You must have the View Users and Roles basic information permission to view information about
other users to add them as locker owners/Managers/participants. Without this permission, an "Access
denied" error will occur.

См. RBAC for Credential Vault credentials management

There is no limit on the number of credentials that can be stored in a ячейка. A credential can only
belong to one ячейка. См. раздел Создать учетные данные. Credentials are further divided in logical
groups called ячейки.
To create a ячейка, follow these steps:
1. Navigate to Manage > Credentials, and then click the Lockers tab.
2. Click Create locker.
3. Введите Имя.
4. Необязательно: Введите описание.
5. Select the Credentials to add to the ячейка or select External key vault.
6. Enter External key vault credentials.

If integrating with an external key vault, such as AWS, Azure, or CyberArk, enter the required
credentials for the specified external locker:

AWS Enter the prefix of secrets stored in the locker.
CyberArk Enter the safe name where the credential lockers

are stored.
Azure Enter the prefix stored in the locker.

7. Щелкните Вперед.
8. Add the Owners.

A ячейка must have at least one owner. The ячейка owner can edit, view, and delete a ячейка and
also add or remove other owners.

9. Щелкните Вперед.
10. Необязательно: Add the Managers and click Next.

The ячейка manager can view, edit and delete the locker, and add participants but cannot add owners
or managers to the ячейка.

11. Необязательно: Add the Participants and click Next.
A ячейка participant has access to view a ячейка and add their own credentials to a ячейка.

Прим.:  A locker participant does not have access to or visibility of credentials created by other
users.

12. Add the Consumers.
Select one or more roles. Users with these roles have access to the ячейка. System-created roles are
not shown in the Consumers list.
Тип Разрешение

Стандартная Locker consumers can view the ячейка and all
the credentials inside the ячейка. All consumers
see the same credential value set by the
credential owner.
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Тип Разрешение

Предоставлено пользователем Locker consumers can input their information
in user-provided credentials with user-provided
attributes.

13. Click Create locker.

If the email notification setting is enabled, users receive an email confirming the ячейка name and their
permissions to that ячейка.

Edit a locker
Add or remove credentials, owners, managers, participants, or consumer roles.

Only a ячейка owner, ячейка manager, or ячейка admin can edit a ячейка. To edit a locker, follow the
steps mentioned below:

Прим.:  Credential, owner, managers, participants, and consumers are separate entities associated with
the locker to grant permission. These are not locker entity attributes and modifying these does not change
locker objects. Therefore when you edit these fields inside a locker, the locker object is not modified and
thereby locker's last modified field is also not updated.

1. Navigate to Manage > Credentials, and then click the Lockers tab.
2. Hover over the Actions icon for the locker.
3. Click the Edit icon. ( )
4. You can make changes to the following:

Опция Описание

Учетные данные Add or remove credentials that are assigned to a
ячейка.

Владельцы Add or remove ячейка owners.

Прим.:  A ячейка must have at least one owner.

Менеджеры Add or remove ячейка managers.

Участники Add or remove ячейка participants.

Потребители Add or remove ячейка consumers.

If email notification setting is enabled and credentials are added to a ячейка, then all the ячейка
consumers will receive an email.

5. Щелкните Сохранить изменения.

Credential Vault email notifications
When the email notification setting is enabled, it ensures that users are notified of any changes to
credentials and lockers.
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Обзор

Email notifications are sent for the following scenarios:

Credential is added to a ячейка When credential is added to a ячейка, a notification
is sent to all consumers of the ячейка to their email
address registered in the Control Room. The email
consists of a link to the credential that is added
to the ячейка. The consumers are redirected to
edit the credential page wherein they input the
credential value.

Member is added or removed from a ячейка An email notification is sent when a new member
(co-owner or participant) is added to a ячейка
or removed from the ячейка as a member of
participant.

Change in permission for ячейка members When a ячейка owner/admin grants or removes
ячейка membership permissions from a ячейка, an
email notification is sent to the ячейка members
at their email address. This ensures that members
are notified of their membership changes within the
ячейка.

Locker consumer gets added or removed from
a role assigned to a ячейка, or consumer role
gets added or removed from a ячейка

When a role assigned to a ячейка is modified by
addition or removal of users, an email notification
is sent to the new or existing user at their email
address so that the consumers are notified that
credentials are pending for their input in the
ячейка.
Also when a new role added to a ячейка or an
existing role is revoked from the ячейка, an email
notification is sent to the new or existing consumers
at their email address so that the consumers are
made aware of the changes.

External key vaults for Automation 360
External key vaults provide a secure, encrypted storage space for sensitive data used by RPA. Customers'
sensitive data can be accessed and used by their RPA platform by storing the data in a corporate-approved
key vault, such as CyberArk Password Vault, AWS Secrets Manager, or Azure Key Vault.
Automation Anywhere provides a secure key vault called Credential Vault. Requirements for external
key vault usage are generally related to certain compliance standards and corporate security policies
implemented by your IT and IT security groups. As part of their data security policies, these groups select
and maintain corporate key vault services, and define the standards for the protection of sensitive data.
The Automation 360 Control Room leverages external key vaults to store credentials for security and
compliance.

Прим.:  External key vault integration is not supported on Oracle Database.
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Пользователи и функции

The following users typically configure and work with external key vaults:

RPA Administrators RPA Administrators who have AAE_Admin and
AAE_Locker_Admin roles with permissions to
administer Automation 360 Control Room and
Credential Vault instances. The RPA Admin works
with the customer External Key Vault Admin.

Customer External Key Vault Administrators Customer External Key Vault Administrators who are
responsible for the administration and management
of the external key vault tasks (for example, setting
up, managing, and creating access policies).

Преимущества

The Automation Anywhere Credential Vault is secure and provides deep integration with the RPA platform.
However, because corporate IT must provide secure data services as part of their IT security policies, the
RPA platform might be required to use external key vault technology to comply with corporate standards.
External key vaults enable the RPA platform to fully comply with corporate requirements and can provide
these additional benefits:
• Deep integration with the Identity Provider (IdP) and corporate authentication platforms such as single

sign-on (SSO) and Directory Services (such as Microsoft Active Directory).
• Support of password rotation and synchronization with the systems used with the RPA platform.
• Administration of the key vault and security best practices are performed by the IT group who manages

the external key vault instead of the RPA administrators. As a result, the RPA platform becomes a
consumer of the credential service.

Guidelines

External key vault integration guidelines support the operation of the RPA platform relating to the
coordination, configuration, and consumption of credentials and sensitive data from the external key vault
technology.
• Coordination: Establish designated contacts for the key vault and RPA platform technologies and

identify the individuals responsible for communicating operational guidelines, security policy, and
compliance requirements for credential management.

• Configuration: Designated contacts collaborate on the use case implementation and configuration
requirements of the RPA platform and the external key vault.

• Consumption: Based on which use cases are implemented, designated contacts monitor the
integration of the RPA platform and the external key vault and coordinate credential rotation and
naming requirements.

Integrating external key vault with Control Room
Automation Anywhere Control Room supports these external key vaults: CyberArk Password Vault, AWS
Secrets Manager, and Azure Key Vault.
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Use cases

The following use cases are supported:

Control Room bootstrap Retrieval of credentials used by the Control Room
to authenticate to supporting services such as
database and Control Room software service
account.

Control Room system Retrieval of credentials used by the Control
Room for Active Directory (AD) and email (SMTP)
integration.

Agent auto-login Retrieval of credentials used by the RPA platform to
launch automations on designated Automation 360
Bot Agent devices.

Agent automation Retrieval of credentials that the automation (бот)
uses during runtime to perform authentications to
the applications that are being automated.

Plan your integration

Before you integrate your external key vault with the Automation 360 Control Room, you need to develop
an overall external key vault strategy.
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The answers to these questions will help determine the integration requirements for the external key vault.

What type of Automation 360 Control Room
deployment do you have: On-Premises or
Cloud?

• On-Premises. The Control Room and external
key vault are hosted at the customer's site and
environment.

The external key vaults might contain these
external key vaults hosted within the customer
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site (customer-controlled datacenter or
environment):
• CyberArk Password Vault – Customer On-

Premises environment
• AWS Secrets Manager – Customer AWS

environment
• Azure Key Vault – Customer Azure

environment

You can configure the external key vault
connection during initial installation or post-
installation using the key vault utility.

• Cloud. The Control Room is hosted on the
Automation 360 Cloud environment and the
external key vault is hosted within the customer
site (where the customer-controlled datacenter
is either On-Premises or in a Cloud environment
such as AWS):

The key vault in the customer network requires
connection to the Automation 360 Cloud Control
Room. You configure the connection to the
external key vault from the Automation 360
user interface. Customer network perimeter
configuration is required.

What type of third-party external key vault
do you have?

CyberArk Password Vault, AWS Secret Manager, or
Azure Key Vault.
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Each external key vault has their own specific
requirements. Review all configuration requirements
with RPA and external key vault administrators
before starting the integration.

What type of credentials do you need to
retrieve from the external key vault based on
the supported use cases?

By integrating the Automation 360 Control Room
with your external key vault, you can retrieve
credentials that support these use cases:

Пример
использования

Учетные
данные

Supported
deployment

Credential
caching

Credential
rotation

Control
Room
bootstrap

Used to
authenticate
the
database
and
(optionally)
start the
Control
Room
services
(Service
account)

On-
Premises
only

Caches
the
retrieved
values

You
should
rotate
the
database
credential
during
scheduled
downtimes

Control
Room
system

Used to
authenticate
to Active
Directory
(AD),
Service
account,
and
SMTP

On-
Premises
only

Caches
the
retrieved
values

You
should
rotate
the AD,
Service
account,
and
SMTP
credentials
during
scheduled
downtimes

Agent
auto-
login

Used
by Bot
Agent to
perform
auto-
login on
a Bot
Agent
device
before
launching
an
automation

On-
Premises
и Cloud

Does
not
cache
values
from
external
key
vault

Always
retrieves
the
latest
available
credential
rotated
in the
external
key
vault
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Пример
использования

Учетные
данные

Supported
deployment

Credential
caching

Credential
rotation

Agent
automation

Used
by the
automation
to
authenticate
to the
applications
being
automated

On-
Premises
и Cloud

Does
not
cache
values
from the
external
key
vault

Always
retrieves
the
latest
available
credential
rotated
in the
external
key
vault

Coordinate with external key vault admin team

To ensure a productive, efficient, and rapid integration with the external key vault, you must coordinate
with the external key vault administration team and exchange the technical requirements of the RPA
platform. By carefully planning and coordinating with the external key vault administration team, you can
quickly integrate the Automation Anywhere Control Room with the external key vault and avoid time-
consuming troubleshooting issues.
We suggest you follow these guidelines to structure your integration process:
• Review the supported credential use cases to determine which credentials the RPA platform requires to

retrieve from the external key vault.
• Schedule a kick-off meeting with the external key vault administration team to exchange information for

these details:
• Which key vault to use?
• Which use cases to configure?
• What are the credential naming conventions required by the RPA platform?
• How are the credentials configured and updated on the external key vault?
• Does the external key vault have multiple instances (multiple instances of the external key vault can

be used for different Automation Anywhere Control Room instances)?
• Who are the designated contacts for the RPA platform and key vault administration?
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• Review the configuration requirements for the Control Room:
• Are you installing a new Control Room with key vault integration?

If so, then review the installation procedure for the external key vault integration.
• Are you configuring an existing Control Room to use external key vault integration for the first time?

If so, then review the key vault utility usage procedure to configure key vault integration post-
installation.

• Is the Control Room an Automation 360 Cloud Control Room that will connect to an on-premises key
vault?
If so, then you must coordinate with your IT networking team to configure connectivity between the
Cloud Control Room and your internal network.

• Review the external key vault configuration procedure and note all integration settings requirements:
• Key vault configuration requirements to configure on the external key vault before integration
• Control Room operating system configuration
• Authentication method that the Control Room will use to connect to the external key vault

• Schedule integration meetings to coordinate these configuration and set up tasks for the Control Room
and external key vault administrators:
• Configuration of the key vault connection
• Configuration of each use case
• Testing of each use case

Прим.:  These integration meetings should be ongoing until you have configured and tested all use
cases.

• Add the external key vault integration to regular IT cadence meetings to monitor the operation of the
Control Room and the external key vault, specifically credential rotation coordination.

External key vault naming conventions
Specific authentication credentials and external key vaults have restrictions on the use of certain characters
in usernames, phrases, and other text. Also, there are different naming conventions to follow based on the
external key vault and the credential use cases: Agent auto-login or Agent automation.

Agent auto-login naming conventions

• CyberArk: All Agent auto-login credentials are retrieved from the specified safe name and assumed to
exist within the Auto-login Credential Safe.

• AWS Secrets Manager and Azure Key Vault: All Agent auto-login credentials must adhere to the
required naming conventions detailed on this page.

If the Control Room performs an auto-login credential retrieval but no credential exists in the Auto-
login Credential Safe that matches that user name, then the auto-login will fail. For any unattended
automations, all robotic or digital worker user IDs must have an auto-login credential configured for each
Control Room user within the external key vault.
The Control Room retrieves auto-login credentials based on the object naming convention within the
external key vault. The Control Room searches for an object where the object name (the credential name
in the external key vault) matches the Control Room username for which it is performing auto-login.
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The prefix autologin_ is required as part of the naming convention for auto-login credentials for all
external key vaults: CyberArk, AWS, and Azure. The name of the auto-login credential in the external key
vault must contain autologin_ followed by the Control Room username. In some cases, certain key
vaults have restrictions on the characters that can be used in credential object names. Additionally, to
support how different use cases encode credentials, Automation 360 requires that certain characters be
reserved or encoded.
The following table lists examples of the object naming conventions expected in the Control Room:

Control Room username Expected object name format

ABCD\user123 autologin_ABCD--user123

user123@rpa.abcd.com autologin_user123-40-rpa-2e-abcd-2e-com

Прим.:  For On-Premises customers using AD authentication, you must format auto-login usernames
using the UPN format or domain\username postfix.

For auto-login credentials, keep these in mind:
• The object name in the external key vault must contain autologin_ as a prefix.
• The auto-login credential names must map to the Control Room username (login ID) for the credential

being retrieved.
Some external key vaults have usage restrictions of certain characters, such as backslash (\) and
ampersand (@) in the secret name (object name), and restrictions on how special characters are
interpreted within API calls. If the user ID contains special characters, then you must encode the secret
name (object name) in the external key vault using ASCII code character substitutions, as listed in the
following table.

This character Changes to this ASCII code character
substitution

\ (backslash) --

- (dash) -2d-

_ (underscore) -5f-

@ (ampersand) -40-

. (period) -2e-

Прим.:  Except for the backslash being mapped to double dashes, the dash, period, underscore, and
ampersand are mapped using their ASCII code bracketed in dashes.

Agent automation naming conventions

Agent automation credentials are credentials retrieved by the automation during runtime and used by the
automation бот to authenticate with applications. Automation credentials retrieved from external key vaults
are mapped in the Automation Anywhere Credential Vault using the External Key Vault option when
configuring lockers and credentials.
The Automation Anywhere ячейка is mapped to either of the following:
• Safe Name (CyberArk)
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• Secret Name Prefix (AWS and Azure)

A credential is mapped to either of the following:
• An Object Name (CyberArk)
• A Secret Name body (AWS and Azure)

Прим.:  You can map any Automation Anywhere ячейка to any CyberArk Safe Name. The Safe Names
used to map Automation Credentials should be distinct from the Safe Name used for auto-login.

To support the Automation Anywhere user-defined credentials functionality, you can create credentials
using a Control Room_username postfix because these credentials are retrieved based on the user context
of the running бот. If you do not create user-defined credentials, then the automation бот credential
retrieval process retrieves the system credential.

Прим.:  For On-Premises customers using AD authentication, you must format Agent automation
usernames using the UPN format or domain\username postfix.

External key vaults prohibit different special characters in secret names. As a result, you must encode
some characters in the credential (secret) name in the external key vault based the type of external key
vault (CyberArk, AWS, or Azure) you are using and its specific requirements.

CyberArk Password Vault automation example

The following table shows CyberArk external key vault examples using naming conventions for automation.

Прим.:  The Safe Name maps to the locker for the Control Room, and the Object Name maps to the
credential for the Control Room.

Automation credential
example

Safe Name Object in locker Control Room username

System credential in locker
mapped to Safe Name

finance glaccess None - system credential

User-defined credential in
locker mapped to Safe Name

finance glaccess_ABCD--RPA--
user123

ABCD\RPA\user123

User-defined credential in
locker mapped to Safe Name
where username is encoded
with ASCII mapping

finance glaccess_ABCD--RPA-2e-
user123

ABCD\RPA.user123

AWS Secrets Manager automation example

The following table shows AWS Secrets Manager external key vault examples using naming conventions for
automation.

Прим.:  The AWS Secret Name Prefix maps to the locker for the Control Room, and the AWS Secret Body
maps to the credential for the Control Room.
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Automation credential
example

AWS
Prefix

AWS
Secret
Body

Secret in AWS Control Room
username

accounting_pdf
System credential in locker
mapped to AWS Secret
Name prefix accounting

accounting pdf accounting_pdf
(system)

None - system
credential

accounting_pdf_ABCD--
user123
User-defined credential
in locker mapped to
AWS Secret Name prefix
accounting

accounting pdf accounting_pdf_ABCD--
user123

ABCD\user123

Azure Key Vault automation example

The following table shows Azure Key Vault external key vault examples using naming conventions for
automation.

Прим.:  The Azure Prefix maps to the locker for the Control Room, and the Azure Secret Body maps to the
credential for the Control Room.

Automation
credential
example

Azure Prefix Azure Secret Body Secret in Azure Control Room
username

accounting_cv1
System credential
in locker mapped
to Azure Secret
name prefix
accounting

accounting cv1 pdf-5f-cv1
(system)

None - system
credential

accounting_cv1_ABCD
\user123
User-defined
credential in locker
mapped to Azure
prefix

accounting cv1 pdf-5f-cv1-5f-
ABCD--user123

ABCD\user123

When deploying Azure credentials, the Azure Key Vault character underscore (_) is a reserved character
and cannot be used in credential names. You must substitute any underscore (_) usage with the ASCII
code value 5f bracketed by dashes:

This character Changes to this ASCII code character
substitution

\ (slash) --
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This character Changes to this ASCII code character
substitution

- (dash) -2d-

_ (underscore) -5f-

@ (ampersand) -40-

. (period) -2e-

Integrating CyberArk Password Vault with Automation 360
You can integrate Automation 360 to retrieve credentials from the CyberArk Password Vault. The
credentials become resident within the CyberArk Password Vault where they are managed, rotated, and
synchronized.
You integrate the Automation 360Control Room by connecting it to the CyberArk Password Vault through
the CyberArk Central Credential Provider (CCP) APIs. No additional licensing is required to integrate with
the CyberArk Password Vault or use the CCP APIs.

Прим.:  We recommend that you control access to the CyberArk Password Vault through an IP address.

You can integrate Automation 360 with the CyberArk Password Vault using either of these deployments:
• Cloud
• On-Premises

The following diagram shows an Automation 360 Cloud deployment where the Control Room is hosted on
AAI Cloud:
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For On-Premises deployments, you deploy the following:
• Control Room as software within your customer environment.
• Bot Agent within your customer environment where automations run and access customer applications.

Важное замечание:  You can edit the external key vault connection settings through the user interface
in Cloud deployments only. External key vault settings in On-Premises deployments are only configurable
during installation or with the key vault utility post-installation.

CyberArk Password Vault integration requirements

• Install CyberArk Central Credential Provider
• Implement X.509 client certificate authentication method
• CyberArk Central Credential Provider API configuration requirements
• Review CyberArk Credential terminology and identifiers
• Define CyberArk application ID
• Provision accounts in CyberArk Password Vault
• Set up access to the application and password providers
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Install CyberArk Central Credential Provider

You must install and configure the CyberArk Central Credential Provider on the CyberArk server. См.
раздел CyberArk Central Credential Provider installation.

Implement X.509 client certificate authentication method

An X.509 client certificate is a type of digital certificate used by client systems to make authenticated
requests to a remote server and uses the widely accepted international X.509 public key infrastructure
(PKI) standard to verify that a public key belongs to the user, computer, or service identity contained within
the certificate.
The Automation 360Control Room uses a client certificate as the authentication method when connecting
to the CyberArk CCP APIs.
This authentication method is highly secure and leverages the system's truststore to store the client
certificate, server certificate, and private key. The truststore is a certificate storage location provided by
the operating system's software and it contains the issuing Certificate Authority's (CA) certificate. You can
import individual server certificates into the truststore. However it is more efficient to import the issuing
Certificate Authority (CA) certificate.
The following image provides an overview of certificate-based authentication:
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1. The client (Automation 360 Control Room) sends a request to the CyberArk AIM server (protected
resource).

2. The server then responds by sending a certificate back to the client.
3. The Automation 360 Control Room verifies the certificate sent by the CyberArk AIM server by

validating it against the trusted server certification information stored in the public part of the Control
Room truststore.

4. After validating the information in the truststore, the Automation 360 Control Room resends the
certificate back to the CyberArk AIM server.

5. The CyberArk AIM server then validates the certificate sent by Automation 360 Control Room against
the trusted client certification information stored in the public part of the AIM server truststore
Because client certificates (those with their private key) are generally distributed in
password protected format, the certificate file (using .p12 format, such as: c:\PATH
\aaeCyberArkCertificate.p12) requires a passphrase.
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6. Both parties (client and server) gain access to the protected resources if the certificates pass
validation based on the following:
• The Control Room certificate must be trusted by the CyberArk AIM server
• The Control Room must trust the certificate on the CyberArk AIM server
• The Subject field in the certificate matches the calling system's Fully Qualified Domain Name (DNS

Name)
• The certificate has not expired

Важное замечание:  As part of the integration planning phase, coordinate certificates and requests
for certificates. You will have to request that certificates be issued by the Public Key Infrastructure (PKI)
team before you can begin integration configuration. The certificate files are stored in the PKI folder
and accessed with the Control Room passphrase when required. The Control Room passphrase is stored
encrypted in the keyvault.properties file.

CyberArk Central Credential Provider API configuration requirements

You must have network connectivity between the Automation 360 Control Room and the CyberArk AIM
server. The Automation 360 Control Room is connected to the CyberArk Password Vault through the
CyberArk Central Credential Provider (CCP) APIs for both On-Premises or Cloud deployments.

Прим.:  No additional licensing is required to use the CCP APIs.

To use the CCP API, you must set these required parameters:
• Automation 360 v.20 (supports bootstrap credentials with On-Premises deployment only)
• Automation 360 v.21 or later (supports all bootstrap and system use cases for On-Premises

deployments, auto-login, and automation credentials for both On-Premises and Cloud deployments)

© 2023 Automation Anywhere. All rights reserved.     2877



    Automation Anywhere - Управление

• The Control Room Key Vault contains these connection details:
• CCP API vault connection URL – For example: https://<host:port>/AIMWebService/api/

Accounts?
• CCP API AppID – You must configure the CyberArk AIM server with an Application ID (AppID).

Пример. AACompanyControlRoom1.
См. раздел Define CyberArk application ID.

• X.509 client certificate with private key issued to the Automation 360 Control Room
(The Control Room Fully Qualified Domain Name is in the Subject: field of the certificate)
and configured with the CyberArk AIM server for authentication. For example: c:\PATH
\aaeCyberArkCertificate.p12

Прим.:  The .p12 format is required.

Review CyberArk Credential terminology and identifiers

CyberArk and Automation Anywhere use different terminology to describe and identify credentials:

Описание CyberArk Automation Anywhere

Where credentials are stored object учетные данные

Primary partitioning of the key
vault

safe (contains objects) locker (contains credentials)

• Credentials in CyberArk are stored in objects, and each object is contained in a safe.
A single CyberArk instance can have multiple safes, where each safe has access controls for users.

• Credentials in Automation Anywhere are stored in lockers, where each locker has access controls for
Control Room users.

CyberArk identifies credentials by safe name AND object name. The CCP API uses a CyberArk safe name
and CyberArk object name to access credentials within the CyberArk Password Vault (the credential must
exist in CyberArk).
The following is a code sample CCP API call and corresponding response:

https://<host:port>/AIMWebService/api/Accounts?
AppID=BillingApp&Query=Safe=Billing;Object=MonthlyBilling

Ответ

{
       "Content":"",
       "PolicyID":"CyberArk",
       "CreationMethod":"PVWA",
       "Folder":"Root",
       "Address":"address tbd",
       "Name":"Application-CyberArk-address tbd-vb",
       "Safe":"aa_vb_safe",
       "DeviceType":"Application",
       "UserName":"vb",
       "PasswordChangeInProcess":"False"
}
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The credential value or secret (for example, the password) is stored in the Content attribute and the User
ID (the Control Room user name, for example vb) is stored in the UserName attribute.

Define CyberArk application ID

Automation 360 integrates with CyberArk Password Vault through the CyberArk Central Credential Provider
(CCP) API. The application ID (AppID) is a required configuration parameter.
As a CyberArk Administrator, use the CyberArk Password Vault Web Access (PVWA) interface to define the
application ID by following the specified procedure to prepare the CyberArk AIM server for integration with
the Control Room. См. раздел CyberArk Password Vault Web Access.
1. You must log in as a user allowed to manage applications on the CyberArk platform (requires Manage

Users authorization).
2. From the Applications tab, click Add Application.
3. From the Add Application panel, enter the following information:

Вариант Действие

Имя Specify the unique name (ID) of the application.
We recommend using a name based on the Control Room name or
function, for example: AACompanyControlRoom1.

Описание Enter a short application description used to help identify it.

Business owner Enter contact information about the application's business owner.

Место
проведения

Select the application location in the Vault hierarchy.
If a location is not selected, the application will be added in the
same location as the user who is creating this application.

4. Click Add to add the new application and display it on the Applications Details page.
5. From the Applications Details page, select the Allow extended authentication restrictions

check box to specify an unlimited number of machines and Windows domain OS users for a single
application.

6. From the Authentication tab, click Add to add details to the new application.
A list of available authentication characteristics are displayed, which the Credential Provider uses to
verify before retrieving the application password.

7. Необязательно. Select OS user and enter the name of the user who will run the application, and
then click Add to add the OS user to the list of users in the Authentication tab.

8. Select Certificate Serial Number and enter the certificate serial number for the Control Room client
certificate, and then click Add.
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9. (Automation 360 recommended): From the Allowed Machines tab, click Add, and specify the IP/
host name/DNS address where the application is allowed to run and request passwords.
CyberArk AIM uses this address to ensure that only applications which run from specified machines
can access their passwords.

10. Click Add to add the IP address to the list of allowed machines.

Provision accounts in CyberArk Password Vault

Before an application can function, you must give the application access to existing user accounts or to
new user accounts to provision in the CyberArk Password Vault.
Use the Password Safe to provision the privileged user accounts required by the application. You can
provision accounts using one of these methods:
• Manually add accounts one at a time, and then specify all the account details.
• Automatically add multiple accounts using the Password Upload feature. To add account

automatically, you must have authorization to the Add accounts feature in the Password Safe.

For details about adding and managing privileged accounts, see Privileged Access Manager - Self-Hosted.

Set up access to the application and password providers

After the user accounts have been provisioned by CyberArk, you must set up access to both the application
and to CyberArk Application Password providers who are serving the application.
From where the Central Credential Provider is installed, add the provider user and application users as
members of the Password Safes (where the application passwords are stored). You can add the users
using one of these methods:
• Manually from the Safes tab
• By specifying the Safe names in the CSV file when adding multiple applications

To add users as safe members, from the Add Safe Member dialog box, add the provider as a safe
member with these access authorizations selected, and then click Add:
• Retrieve accounts (Access)
• List accounts (Access)
• View Safe Members (Monitor)
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Прим.:  When installing multiple providers for the CyberArk Password Vault integration, we recommend
that you first create a group for them, and then add that group to the safe with the same selected access
authorizations.

To add application (AppID) as a safe member, perform these steps:
1. From the Add Safe Member dialog box, add the (AppID) as a safe member with Retrieve accounts

(Access) selected as the access authorization.
2. Click Add.

If the safe is configured for object level access, ensure that both the provider user and the application
have access to the passwords to retrieve. For details about adding and managing privileged accounts, see
Privileged Access Manager - Self-Hosted.

On-Premises integration using CyberArk Password Vault
As an Automation 360 administrator, you can configure the CyberArk On-Premises integration using one of
these methods: initial installation or post-installation using a command-line interactive key vault utility.
Within the On-Premises installation wizard, bootstrap credential retrieval from external key vault
configuration options are only available if you first configure the key vault connection. The configuration
options vary based on the external key vault you select.

Прим.:  If you are using CyberArk in an Automation 360 Cloud deployment, then the CyberArk external
key vault must be reachable from the Cloud Control Room through the network perimeter firewall rules.
For external firewall rules configuration details, see Automation 360 IP addresses for external integrations.

Choose your integration method:
• Initial installation
• Post-installation using key vault utility
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On-Premises initial installation using CyberArk Password Vault
Using the initial installation method, you can connect and configure the external key vault connector,
service account credential (Active Directory master password), and bootstrap (database) credential
identifier.

Прим.:  You must select Microsoft SQL Server Authentication as the database; other database
authentication methods are not supported for this use case.

The initial installation supports a password-less installation regarding the Control Room bootstrap
credentials. The password-less installation identifies the bootstrap credentials by the Safe name and Object
name within CyberArk.
You can configure the SMTP and AD credential identifier to retrieve from the external key vault using the
Automation 360 user interface.
1. After you start the Automation 360 installation wizard, select On-premises as the Deployment

Option and click Next.
2. Accept the license agreement and click Next.
3. Select Custom as the Installation Type Preference and click Next.
4. Accept the default locations for the destination folders and click Next.
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5. To connect and configure the external key vault integration, select CyberArk.
a) In the Vault URL field, enter the CyberArk AIM server CCP API URL (for example: https://

<hostname:port_num>/.

Прим.:  To access the CCP APIs, the Control Room will automatically append /
AIMWebService/api/Accounts? to the vault URL you enter. As a result, you must configure
the Web Service on the CyberArk AIM server as AIMWebService.

b) In the Application ID field, enter the CCP API AppID (for example: AAEControlRoom).
c) Enter the path to the CyberArk AIM server certificate (in .pem format using .p12) issued to

the Control Room server (The certificate Subject: field contains the Control Room fully qualified
domain name (FQDN)).
This certificate must be trusted by and configured within CyberArk.

d) Click Upload Certificate to store on the Automation 360 Control Room server.
e) Enter the certificate file passphrase used to access the Control Room certificate file.
f) Необязательно: If the issuing Certificate Authority (CA) of the CyberArk server certificate is not

trusted by the Control Room, then enter an optional server certificate.
This is the server certificate for the CyberArk server without a private key (the certificate Subject:
field contains the CyberArk AIM Server FQDN). The installer will add the optional CyberArk Server
certificate to the truststore used by the Control Room.

g) Щелкните Вперед.

6. Accept the default settings from the TLS Configuration dialog box and click Next.
7. From the Service Credentials dialog box, select an option to specify the Safe name and Object

name from CyberArk instead of manually entering the user name and password for the Service
Account used by the Control Room.
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8. Click Service Account (retrieve credential from external key vault), and then enter the Safe
name and Object name values.
The installer will query CyberArk for the credential to validate that the object exists in the specified
safe.

Прим.:  If the Service Account option to specify Safe name and Object name is not available,
then this indicates that the CyberArk Password Vault was not previously configured and connected
properly as the external key vault. Contact your AAI Support team or review.
См. также: Troubleshooting external key vaults.

9. Щелкните Вперед.
10. From the Database Server dialog box, select your Database Server and enter the name of your

Control Room database, and then click Next.
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11. From the Database Authentication dialog box, select an option to specify the Safe name and
Object name from CyberArk instead of manually entering the user name and password the Control
Room uses to authenticate to the database.
a) Click SQL Server authentication (retrieve credential from external key vault), and then

enter the Safe name and Object name values.

Прим.:  Enter the same Safe name you previously entered for the Service Account safe
name.

b) Click Next to continue and complete the initial installation.

After you successfully complete the initial installation, the Automation 360 Control Room can access and
retrieve credentials within the CyberArk Password Vault.

On-Premises post-installation using CyberArk Password Vault
You use the command-line interactive key vault utility during a scheduled system downtime and you
must stop all running Control Room services. You should coordinate any key vault configuration
changes that might impact connectivity parameters (such as App ID, vault URL, port numbers, and
certificate) during downtimes with the CyberArk administrative team.

Прим.:  If you use the key vault utility to disable CyberArk Password Vault integration, you must first
unmap any mapped credentials that are in use.

Using the post-installation method, you can perform these actions:
• Modify or configure the external key vault connection parameters.
• (If not configured during initial installation) Modify or configure the service account credential (Active

Directory master password).
• (If not configured during initial installation) Modify or configure the database (bootstrap) credential

identifier (retrieved when authenticating the database).

Прим.:  Retrieving bootstrap credentials from an external key vault might cause the Control Room
to fail if the external key vault is not accessible during boot-up, or if the external key vault is not
accessible when the Control Room refreshes database connections and authenticates users with Active
Directory.
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• Recover the Control Room for these reasons:
• By modifying the external key vault connection parameters, the service account, and database

credential safe and object identifiers.
• If CyberArk Password Vault connection parameters changes caused the Control Room to experience

connectivity issues.
• When credential identifiers for bootstrap passwords change.

You can address any initial configuration settings that were not set correctly and recover the system.

You can configure and edit SMTP and AD credential identifiers to retrieve information from the external
key vault from the Automation 360 Control Room by navigating to Administration > Settings > Active
Directory.
1. Run the key vault utility for the CyberArk Password Vault

Прим.:  You must import the CyberArk server certificate (the certificate issued to the CyberArk
server) to the Java truststore before invoking the dB utility commands. The certificate can be in .cer
(PEM) format and does not contain a private key.

To run the key vault utility and update key vault connection settings:
a) As the Control Room administrator, access the Automation Anywhere Control Room installation

directory that was created during the initial Automation 360 installation.
Пример. C:\Program Files\Automation Anywhere\Enterprise

b) Download the latest version of the key vault utility. To download the jar file used to update the
directory, open a browser and access the A-People site: A-People Downloads page (Login required).

Прим.:  If DB authentication is configured to use external key vault, the utility returns the
following exception: Database currently configured to retrieve credentials
 from key vault. Update database authentication to WINDOWS/SQL to
 proceed further and exit.

The utility requests the user to confirm the action: Disable/update of key vault might
 impact functionalities using key vault (for example, Active Directory
 configuration, Email Settings configuration). Make sure to update these
 settings (if any). Are you sure you want to continue?

c) Enter Y to continue.
d) Enter the following:

> jdk11\bin\java -jar certmgr.jar -appDir . -importTrustCert <Full path
 of the certificate>

e) Add these jvm arguments to the command to run the key vault utility:
1. -Djavax.net.ssl.trustStore="C:\Program Files\Automation Anywhere

\Enterprise\pki\trust\store.ks"

2. -Djavax.net.ssl.trustStorePassword=changeit --module-path lib -
jar crutils.jar -configPath "C:\Program Files\Automation Anywhere
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\Enterprise\config" -action [UPDATE_KEY_VAULT_CONFIGURATION or
 UPDATE_DB_AUTHENTICATION_CONFIGURATION]

You can update either of these configuration actions:
• Enter UPDATE_KEY_VAULT_CONFIGURATION to edit the CyberArk key vault configuration.
• Enter UPDATE_DB_AUTHENTICATION_CONFIGURATION to change to database

authentication using external key vault.

2. Based on which configuration action you used, choose the appropriate action:
• Update key vault configuration for CyberArk: If you entered

UPDATE_KEY_VAULT_CONFIGURATION as the configuration action:
a. After the utility loads the current key vault configuration and properties, and this prompt is

displayed: Enter key vault [AWS/CYBERARK/AZURE/NONE] :, enter CYBERARK
b. At the Please enter Vault URL: prompt, enter (for example): https://

services.uscentral.skytap.com:19516

c. At the Please enter Application ID: prompt, enter (for example): AAEControlRoom
d. At the Please enter Certificate path: prompt, enter (for example): C:\Users

\Admin\Downloads\client_combined_cert_key_Adminat1234.p12

Прим.:  The client certificate issued to the Control Room for authenticating to CyberArk must
be in .p12 (pkcs#12) format with the private key.

e. At the Passphrase will not be displayed on the console Passphrase:
prompt, enter your passphrase.

The key vault utility runs. If the configuration was successful (the utility was able to connect to the
external key vault using the configured parameters), these messages are displayed on the console:

Connection configurations valid
  Key Vault configurations successfully updated

• Update database authentication for CyberArk: If you entered
UPDATE_DB_AUTHENTICATION_CONFIGURATION as the configuration action:
a. After the utility loads the current database configuration information, this prompt is displayed:

Database authentication configurations loaded
Currently configured database authentication [SQL]

Change database authentication. Available options:
WINDOWS: Connect to database using windows authentication
SQL: Connect to database using SQL server authentication, manually
 enter username and password
KEY_VAULT: Connect to database using SQL server authentication,
 retrieve username and password from external key Vault 

Enter database authentication [WINDOWS/SQL/KEY_VAULT]:

Enter KEY_VAULT
b. At the Please enter Safe name: prompt, enter (for example): aa_vb_safe
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c. At the Please enter Object name: prompt, enter (for example): Database-MSSql-
administrator-admin

The key vault utility runs. If the database configuration was successful (the utility was able to
connect to CyberArk, retrieve the designated credential and then use the credential to connect to
the database), these messages are displayed on the console:

Database Credentials are valid
Database authentication configurations successfully updated

Cloud integration using CyberArk Password Vault
You connect and integrate the external CyberArk Password Vault to the Automation 360 Control Room.
The following image shows CyberArk Cloud integration with the Control Room:

You must configure the customer network perimeter firewall to allow access to the
CyberArk_CCP_hostname:port from the Automation 360 Cloud AWS NAT Gateway IP addresses.
The following table provides an example of how to configure the customer perimeter firewall:

С До Protocol used

Control Room in Automation
360 Cloud: Three AWS NAT
Gateway IP addresses

CyberArk_CCP
API_hostname:port

For example:
cyberarkpwv.dev.abcd.com:4043

TLS Encrypted CCP API
(TLS mutually authenticated)

For more details, see Automation 360 IP addresses for external integrations.
For Cloud integrations, you can configure the Control Room and external key vault integration using the
Automation 360 Control Room user interface.
The Agent auto-login and Agent automation use cases are only supported on Automation 360 Cloud
Control Room instances. Neither of these use cases affect the Control Room boot sequence or Control
Room functionality.

Прим.:  Bootstrap and service account credential retrieval use cases are not supported on Cloud Control
Room instances because the database and services are managed internally by Automation Anywhere.
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There is no compliance use case (requirement) for these credentials to be stored in the customer external
key vault.

1. Gather the specific CyberArk information required to configure the external key vault connector using
the Automation 360 Control Room.

Элемент Описание

URL-адрес хранилища The CyberArk AIM server CCP API
URL (for example: https://
<hostname:port_num>/

Прим.:  To access the CCP APIs, the
Control Room will automatically append /
AIMWebService/api/Accounts? to the
vault URL you enter. As a result, you must
configure the Web Service on the CyberArk
AIM server as AIMWebService

Идентификатор приложения The CCP API AppID (for example:
AAEControlRoom).
Подробнее см. в разделе Define CyberArk
application ID.

Файл сертификата Enter the path to the client certificate issued
to the Control Room server.
The client certificate file that is issued
for the Control Room is a .p12 file that
contains the private key. CyberArk admins
configure this file on the CyberArk server.
After configuring the certificate file, it is
used to authenticate every client request
that is sent from the Automation 360 Cloud
Control Room to the CyberArk server.
The certificate will be issued to the
Cloud Control Room (Subject: field of the
certificate will contain fully qualified domain
name (FQDN) of the Control Room) by the
customer internal certificate authority.

Certificate file password A password used to open the certificate file.

Server certificate - PEM format (Required only for Cloud integration): The
server certificate without the private key of
the CyberArk AIM server (Subject: field of
the certificate will contain the FQDN of the
CyberArk AIM server).
This server certificate is a public certificate
for the URL where CyberArk is hosted. This
certificate is in the PEM text format and
contains the Subject Alternative Names
(SAN) on which the CyberArk is listening
to requests. Подробнее см. в разделе
CyberArk CACert.
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2. Log in to the Automation 360 Control Room as the Administrator.
3. From the Control Room, navigate to Administration > Settings > External key vault .
4. Click the Edit icon to open the Configuration settings pane.
5. Click CyberArk and then enter the specific CyberArk information described in the preceding table.
6. Click Save changes to connect the external key vault.

CyberArk credential retrieval use cases
You can retrieve CyberArk credentials for these use cases: bootstrap, system, auto-login, and automations.

Retrieve Control Room bootstrap credentials with CyberArk

The Automation 360 Control Room uses bootstrap credentials to access supporting services such as
database, service account, and Active Directory (AD). You configure these credentials during the initial On-
Premises installation or post-installation (using the key vault utility) by specifying the safe name and object
name.
The following images shows the process of retrieving the Control Room bootstrap credentials with
CyberArk:

When required during the bootup sequence or normal operations (such as refreshing a service
authentication), the Control Room uses the key vault connection to retrieve the credential and perform the
required authentication.

Прим.:  You must select the Microsoft SQL Server Authentication for this use case; other database
authentication methods are not supported for bootstrap.

Retrieve Control Room system credentials with CyberArk

Прим.:  You can configure the service account only during the initial installation.

If you configured an external key vault during the initial installation, you can then use the Automation 360
user interface (post-installation) to configure SMTP and Active Directory (AD) credentials.
1. Log in to the Automation 360 Control Room as the Administrator.
2. From the Control Room, navigate to: Administration > Settings > Email Settings.
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3. You can map the AD Master Account credential from the external key vault, configure external
credentials, or set to manual (switch modes of AD Master Account credential retrieval).

Retrieve auto-login credentials with CyberArk

Auto-login credentials are used to authenticate to an Automation 360 Bot Agent device and start an active
Windows session. Robotic Process Automation (RPA) requires an active Windows session to function. Auto-
login occurs prior to the automation running when automations are launched from a remote Bot Agent
device.
The following image shows the process of retrieving the auto-login credentials with CyberArk:

A Control Room administrator can manually launch or schedule a job to launch an automation on a Bot
Agent device by specifying these details:
• Automation (бот) name
• Имя устройства
• User context

The system performs auto-login to the specified device with the user name and password associated with
the user context, and then runs the automation on the device.
To configure retrieval of auto-login credentials from the external key vault, perform these steps:
1. Log in to the Automation 360 Control Room as the Administrator.
2. From the Control Room, navigate to Administration > Settings > Devices.
3. Scroll down to the auto-login settings section and click Edit.
4. If you previously configured CyberArk as the external key vault connection, click Enabled to retrieve

the auto-login credentials from that external key vault.
If this option is disabled, then the external key vault connection was not configured.

Прим.:  If you disable auto-login from the external key vault, then credentials are retrieved using the
AAI Credential Vault and its stored credentials instead.

5. Enter the Safe name (for example: AA_Auto-login_Safe).
The safe name you enter is also known as the Auto-login Credential Safe.

Прим.:  You can only define a single safe to retrieve auto-login credentials, so all auto-login
credentials must be in the designated safe.
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6. Щелкните Сохранить изменения.
If successful, then the auto-login settings successfully saved message is displayed.

CyberArk auto-login credential example

For this auto-login credential retrieval example, consider a Control Room user who wants to deploy a бот
on a device as a specific user. This example uses the following details:
• Automation (бот) name run on a device = ProcureToPayGeoEast
• Agent device name = WinVDI1138
• Agent user context = roboticworker2112@automation.abcd.com

The following image shows this an example of retrieving auto-login credentials with CyberArk:

Before starting the automation, ensure the following:
1. The Control Room connection details have been successfully configured, and the Control Room uses

these connection details to connect to CyberArk and performs authentication.
2. The Control Room queries the Bot Agent device running on device WinVDI1138 to check if there is

an active Windows (operating system) session currently on device WinVDI1138, and if that session
belongs to Agent user robiticworker2112.
If there is an existing session on the device for user robiticworker2112, then there is no need to
perform auto-login and the бот continues with the deployment.

3. However, if there is an no active session or if there is an active session that does not belong to
robiticworker2112, then the Control Room retrieves the auto-login credential from the CyberArk
Password Vault.

4. The Control Room passes the credential (password) to theBot Agent. The Bot Agent performs a
Windows login on device WinVDI1138 as robiticworker2112 (first, logging off any other user
login session) using the auto-login credential for robiticworker2112. The automation (Бот)
ProcureToPayGeoEast then starts to run on device WinVDI1138 as robiticworker2112.
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Retrieve automation credentials with CyberArk

Automation credentials are variables used by бот developers within automation (бот) actions that
define and retrieve data from encrypted storage. The automation uses the credentials to authenticate to
applications (for example: finance application). Automation credentials are retrieved by the Automation
360 Bot Agent during runtime. Within CyberArk, a safe is a locker, and an object is a credential.
The following image shows the process of retrieving automation credentials with CyberArk:

Automation credentials retrieved from the CyberArk Password Vault are mapped in the Automation
Anywhere Credential Vault. The Credential Vault supports these two types of automation credentials:

System credentials Credentials where the value returned by the
credential variable is the same for any automation
that uses that variable.

User-defined credentials Credentials where the value returned by the
credential variable is distinct based on the user
context in which the automation is running.

For both system credentials and user-defined credentials, the бот developer specifies the same credential
variable within the бот code. Then, the system determines which credential to retrieve during бот runtime.
User-defined credentials simplify automation development by enabling бот developers to write code using
a single credential variable where the RPA platform substitutes the value returned during runtime with
a unique user-specific value. Developers can avoid writing duplicate code with different user-specific
credential variables.
The following image shows the relationship between the Automation Anywhere Credential Vault objects
and the CyberArk credentials for system and user-defined credentials:
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• The Control Room locker (Locker1) is mapped to the CyberArk safe name (Safe1).
• The Control Room system credential (Credential1) is mapped to the CyberArk object (Object1).

As an administrator, you create and configure a ячейка and credentials using the external key vault feature
in the Automation 360 Control Room. Within the Control Room, an administrator maps the Automation
Anywhere ячейка (Locker1) to a safe name (Safe1) and maps the credential (Credential1) to an object
name (Object1). The credentials available to Control Room users are determined by what is configured in
the external key vault (CyberArk Password Vault).
If you want to use user-defined credentials with the CyberArk integration, then the CyberArk administrator
must create objects for each user-defined credential by naming those objects with the Control
Room_username postfix. During runtime, the RPA platform retrieves the object name that is named with a
postfix that matches the user context (user-defined credential) in which the automation is running. If there
is no user-defined credential, then the RPA platform retrieves the object name without a username postfix
(and uses the system credential).

Прим.:  You can map any Automation Anywhere ячейка to any CyberArk Safe Name. However, any safe
names you use to map automation credentials should be distinct from the safe names you use for auto-
login.

As an administrator, you can use the access controls in the Automation 360 Control Room to separate
access to credentials by providing users access to a ячейка. You control access to credentials by assigning
different Control Room users to different roles and then associating different ячейки with those roles.
By mapping different CyberArk safes to different ячейки, access to credentials in the CyberArk safes is
mapped to and enforced by the access controls in the Control Room.

Прим.:  The same permissions and privileges (assigned through roles) in the Control Room apply to
credentials mapped to the external key vault.

CyberArk automations credentials retrieval example

To configure automation credentials retrieval and integrate with the CyberArk Password Vault, you first
create a ячейка and then create credentials.
To create a ячейка to integrate with the CyberArk Password Vault, perform these steps:
1. From the Automation 360 Control Room, navigate to Manage > Credential.

A user with Manage my credentials and ячейки permissions is authorized to create credentials.
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2. Click the Lockers tab.
3. Click Create locker.
4. Введите имя для ячейка.

This name is local to the Control Room and does not have any dependency on the CyberArk safe
name.

5. Click External Key Vault and enter the CyberArk safe name in the Safe name field (for example:
Finance_Safe).

6. Щелкните Вперед.
7. Configure Owners, Managers, Participants, and Consumers for the ячейка.
8. Click Create locker.

См. раздел Создать ячейка.

The Control Room is now ready to retrieve credentials and enforce access controls on the mapped
CyberArk safe. To continue, you now create the credentials.
To create a credential to integrate with the CyberArk Password Vault, perform these steps:
1. From the Automation 360 Control Room, navigate to Manage > Credentials.

A user with Manage my credentials and ячейки permissions is authorized to create credentials.
2. From the Credentials tab, select Create Credential.
3. Enter the credential name in the Credential name field.

This name is local to the Control Room and does not have any dependency on the CyberArk safe
name.

4. Click External key vault below the name field.
5. From the list of available ячейки, select the appropriate ячейка that was previously mapped to the

safe name for the credential you are now mapping to the object (credential).
6. Enter the CyberArk object name in the Object name field.
7. Click Validate and retrieve attributes.

The system validates the mapping by attempting to retrieve from the CyberArk Password Vault the
combination of safe name (ячейка) and object name (credential). Within the safe name mapped to
the ячейка, Automation 360 expects objects to use the correct naming conventions. . См. раздел
External key vault naming conventions.
If validation fails, then no object exists in the CyberArk Password Vault with the name that matches
the combination of safe name (ячейка) and object name (credential).
When the system successfully retrieves the object details, it will display the CyberArk Password Vault
object attributes (the fields within the secret).

8. From the list of attributes, select attributes to map to the credential.
9. Click Create credential.

If successful, then the credential successfully created message is displayed.
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Integrating Azure Key Vault with Automation 360
You integrate the Automation 360Control Room to retrieve credentials from the Azure Key Vault.
The credentials become resident within the Azure Key Vault where they are managed, rotated, and
synchronized.
You can integrate Automation 360 with the Azure Key Vault using either of these deployments:
• Cloud
• On-Premises

The following diagram shows an Automation 360 Cloud deployment where with Azure Key Vault:

For On-Premises deployments, you deploy the following:
• Control Room as software within your customer environment.
• Bot Agent within your customer environment where automations run and access customer applications.

Важное замечание:  You can edit the external key vault connection settings through the user interface
in Cloud deployments only. External key vault settings in On-Premises deployments are only configurable

© 2023 Automation Anywhere. All rights reserved.     2896



    Automation Anywhere - Управление

during installation or with the key vault utility post-installation. Customers will need to ensure connectivity
to the external key vaults from their On-Premises deployed Control Room instances.

On-Premises integration using Azure Key Vault
As an Automation 360 administrator, you can configure the Azure On-Premises integration using one of
these methods: initial installation or post-installation using a command-line interactive key vault utility.
Within the On-Premises installation wizard, bootstrap credential retrieval from external key vault
configuration options are only available if you first configure the key vault connection. The configuration
options vary based on the external key vault you select.
Choose your integration method:
• Initial installation
• Post-installation using key vault utility

On-Premises initial installation using Azure Key Vault
Using the initial installation method, you can connect and configure the external key vault connector,
service account credential (Active Directory master password), and bootstrap (database) credential
identifier.

Прим.:  You must select Microsoft SQL Server Authentication as the database; other database
authentication methods are not supported for this use case.

You can configure the SMTP and AD credential identifier to retrieve from the external key vault using the
Automation 360 user interface.
1. Configure the Azure Key Vault requirements from the Microsoft Azure portal.
2. Integrate the Azure Key Vault and Automation 360 Control Room.
3. Set up the authentication type for Automation 360 Control Room users and Azure Key Vault.

After you successfully complete the initial installation, the Automation 360 Control Room can access and
retrieve credentials within the Azure Key Vault.
Configure Azure Key Vault requirements for initial installation
Before you can integrate the Automation 360 Control Room with the Azure Key Vault, you must configure
Azure Key Vault requirements using the Microsoft Azure portal.
1. Sign in to the Microsoft Azure portal: Azure portal

2. Create a key vault in Azure.
См. раздел Quickstart: Create a key vault using the Azure portal.

3. From the Azure Home page, navigate to Home > selected key vault. Generate or import secrets for
the use cases you will be using with the Azure Key Vault.
For example, if you will be using the bootstrap use case, you should generate a secret that contains
the correct database credential that the Control Room will use to authenticate to the database.

4. Collect the following required Azure environment variables that must be set in the environment of the
Control Room Server Microsoft operating system:
• AZURE_CLIENT_ID: The client (application) ID of an App Registration in the tenant.
• AZURE_CLIENT_SECRET: A client secret that was generated for the App Registration.
• AZURE_TENANT_ID: The Azure Active Directory tenant (directory) ID.

5. After you set the environment variables in Azure, you must then add them to the Server Environment
on the Automation 360 Control Room:
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The Azure Key Vault has a flat name space with no organizational containers. There is no safe or locker
within the Azure Key Vault and all credentials are stored together in the same container. Credentials are
stored in objects which only have a secret name.
For RBAC policies and best practices, see What is Azure RBAC?

Integrate Azure Key Vault and Control Room
After you configured the Azure Key Vault requirements using the Microsoft Azure portal, you can integrate
the Azure Key Vault and the Automation 360 Control Room.
1. After you start the Automation 360 installation wizard, select On-premises as the Deployment

Option and click Next.
2. Accept the license agreement and click Next.
3. Select Custom as the Installation Type Preference and click Next.
4. Click Change... to change the destination folder of where to install Automation 360. Browse to select

the folder destination you want and click Next.
5. To connect and configure the external key vault integration, select Azure.

6. In the Vault URL field, enter the Azure Key Vault URL (for example: https://user-db-
vault.vault.azure.net/.

7. Accept the default settings from the TLS Configuration dialog box and click Next.
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8. From the Service Credentials dialog box, select an option to specify the Azure Secret name used
by the Control Room and click Next.

9. From the Database Authentication dialog box, select an option to specify the Secret name from
Azure instead of manually entering the secret name the Control Room uses to authenticate to the
database.

a) Click SQL Server authentication (retrieve credential from external key vault), and then
enter the Azure Secret Name value.

b) Click Next to continue and complete the initial installation.

After you successfully complete the initial installation, the Automation 360 Control Room can access and
retrieve credentials within the Azure Key Vault.

© 2023 Automation Anywhere. All rights reserved.     2899



    Automation Anywhere - Управление

Set up authentication type for Azure Key Vault
After you complete the initial installation and configure Azure Key Vault as the external key vault, you can
set up the authentication type for Automation 360 Control Room users in the Initial Setup (this occurs
directly after the initial installation completes).
1. From the Authentication type for Control Room users dialog box, click Active Directory.

2. Необязательно: Configure the Active Directory integration credential (this is the credential that the
Control Room uses to authenticate users with Active Directory) to be retrieved from Azure Key Vault.
Click External Key vault and enter the Azure secret to retrieve credentials in the field (for example:
userAD).

3. Click Discover connections. The available domains and sites display.
4. Click Next and continue to create the Control Room first admin. Save the Admin user information.

The Control Room will attempt to retrieve the credential from the Azure Key Vault and then
authenticate to the Domain Controller. If this fails, cause might be one of the following:
• There is no secret with that name in the Azure Key Vault
• There is a secret with that name, but it does not contain a username and password that is

authorized for authentication with Active Directory

You can now log in to the Control Room as admin and add users and roles.

Прим.:  The passwords within the Azure Key Vault are masked so ensure that you copy and save them
after you create them.

On-Premises post-installation using Azure Key Vault
You use the command-line interactive key vault utility during a scheduled system downtime
and you must stop all running Control Room services. You should coordinate any key vault
configuration changes that might impact connectivity parameters (such as AZURE_CLIENT_ID,
AZURE_CLIENT_SECRET, and AZURE_TENANT_ID) during downtimes with the Azure administrative
team.

Прим.:  If you use the key vault utility to disable Azure Key Vault integration, you must first unmap any
mapped credentials that are in use.

Using the post-installation method, you can perform these actions:
• Modify or configure the external key vault connection parameters.
• (If not configured during initial installation) Modify or configure the service account credential (Active

Directory master password).
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• (If not configured during initial installation) Modify or configure the database (bootstrap) credential
identifier (retrieved when authenticating the database).

Прим.:  Retrieving bootstrap credentials from an external key vault might cause the Control Room
to fail if the external key vault is not accessible during boot-up, or if the external key vault is not
accessible when the Control Room refreshes database connections and authenticates users with Active
Directory.

• Recover the Control Room for these reasons:
• By modifying the external key vault connection parameters, the service account, and database

credential safe and object identifiers.
• If Azure Key Vault connection parameters changes caused the Control Room to experience

connectivity issues.
• When credential identifiers for bootstrap passwords change.

You can address any initial configuration settings that were not set correctly and recover the system.

You can configure and edit SMTP and AD credential identifiers to retrieve information from the external
key vault from the Automation 360 Control Room by navigating to Administration > Settings > Active
Directory.
1. Run the key vault utility for the Azure Key Vault: To run the key vault utility and update key

vault connection settings:
a) As the Control Room administrator, access the Automation Anywhere Control Room installation

directory that was created during the initial Automation 360 installation.
Пример. C:\Program Files\Automation Anywhere\Enterprise

b) Download the latest version of the key vault utility. To download the jar file used to update the
directory, open a browser and access the A-People site: A-People Downloads page (Login required).

Прим.:  If DB authentication is configured to use external key vault, the utility returns the
following exception: Database currently configured to retrieve credentials
 from key vault. Update database authentication to WINDOWS/SQL to
 proceed further and exit.

The utility requests the user to confirm the action: Disable/update of key vault might
 impact functionalities using key vault (for example, Active Directory
 configuration, Email Settings configuration). Make sure to update these
 settings (if any). Are you sure you want to continue?

c) Enter Y to continue.
d) Enter the following:

> jdk11\bin\java -jar certmgr.jar -appDir . -importTrustCert <Full path
 of the certificate>

e) Add these jvm arguments to the command to run the key vault utility:
1. -Djavax.net.ssl.trustStore="C:\Program Files\Automation Anywhere

\Enterprise\pki\trust\store.ks"

2. -Djavax.net.ssl.trustStorePassword=changeit --module-path lib -
jar crutils.jar -configPath "C:\Program Files\Automation Anywhere
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\Enterprise\config" -action [UPDATE_KEY_VAULT_CONFIGURATION or
 UPDATE_DB_AUTHENTICATION_CONFIGURATION]

You can update either of these configuration actions:
• Enter UPDATE_KEY_VAULT_CONFIGURATION to edit the Azure Key Vault configuration.
• Enter UPDATE_DB_AUTHENTICATION_CONFIGURATION to change to database

authentication using external key vault.

2. Based on which configuration action you used, choose the appropriate action:
• Update key vault configuration for Azure: If you entered

UPDATE_KEY_VAULT_CONFIGURATION as the configuration action:
a. After the utility loads the current key vault configuration and properties, and this prompt is

displayed: Enter key vault [AWS/CYBERARK/AZURE/NONE] :, enter AZURE
b. At the Please enter Vault URL: prompt, enter (for example): https://user-db-

vault.vault.azure.net/

The key vault utility runs. If the configuration was successful (the utility was able to connect to the
external key vault using the configured parameters), these messages are displayed on the console:

Connection configurations valid
  Key Vault configurations successfully updated

• Update database authentication for Azure: If you entered
UPDATE_DB_AUTHENTICATION_CONFIGURATION as the configuration action:
a. After the utility loads the current database configuration information, this prompt is displayed:

Database authentication configurations loaded
Currently configured database authentication [SQL]

Change database authentication. Available options:
WINDOWS: Connect to database using windows authentication
SQL: Connect to database using SQL server authentication, manually
 enter username and password
KEY_VAULT: Connect to database using SQL server authentication,
 retrieve username and password from external key Vault 

Enter database authentication [WINDOWS/SQL/KEY_VAULT]:

Enter KEY_VAULT
b. At the Please enter Secret name: prompt, enter (for example): testDB

The key vault utility runs. If the database configuration was successful (the utility was able to
connect to Azure, retrieve the designated credential and then use the credential to connect to the
database), these messages are displayed on the console:

Database Credentials are valid
Database authentication configurations successfully updated
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Cloud integration using Azure Key Vault
For Cloud integrations, you can configure the Control Room and external key vault integration using the
Automation 360 Control Room user interface.
The Agent auto-login and Agent automation use cases are only supported on Automation 360 Cloud
Control Room instances. Neither of these use cases affect the Control Room boot sequence or Control
Room functionality.

Прим.:  Bootstrap and service account credential retrieval use cases are not supported on Cloud Control
Room instances because the database and services are managed internally by Automation Anywhere.
There is no compliance use case (requirement) for these credentials to be stored in the customer external
key vault.

1. Gather the specific Azure information required to configure the external key vault connector using the
Automation 360 Control Room.

Элемент Описание

URL-адрес хранилища The Azure Key Vault URL of the resource
group (for example: https://user-db-
vault.vault.azure.net/).

Идентификатор клиента The client (application) ID of an App
Registration in the tenant.

Секрет клиента A client secret that was generated for the
App Registration.

Идентификатор участника The Azure Active Directory tenant (directory)
ID.

2. Log in to the Automation 360 Control Room as the Administrator.
3. From the Control Room, navigate to Administration > Settings > External key vault.
4. Click the Edit icon to open the Configuration settings pane.
5. Click Azure and then enter the specific Azure information described in the preceding table.
6. Click Save changes to connect the external key vault.

Azure credential retrieval use cases
You can retrieve Azure credentials for these use cases: bootstrap, system, auto-login, and automations.

Retrieve Control Room bootstrap credentials

Прим.:  This use case applies to On-Premises deployments only.

The Automation 360 Control Room uses bootstrap credentials to access supporting services such as
database, service account, and Active Directory (AD). You configure these credentials during the initial On-
Premises installation or post-installation (using the key vault utility) by specifying the object name.
The following image shows the process of retrieving the Control Room bootstrap credentials with Azure:
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When required during the bootup sequence or normal operations (such as refreshing a service
authentication), the Control Room uses the key vault connection to retrieve the credential and perform the
required authentication.

Прим.:  You must select the Microsoft SQL Server Authentication for this use case; other database
authentication methods are not supported for bootstrap.

Retrieve Control Room system credentials

Прим.:  This use case applies to On-Premises deployments only, and you can configure the service
account only during the initial installation.

If you configured an external key vault during the initial installation, you can then use the Automation 360
user interface (post-installation) to configure SMTP and Active Directory (AD) credentials.
1. Log in to the Automation 360 Control Room as the Administrator.
2. From the Control Room, navigate to: Administration > Settings > Email Settings.
3. You can map the AD Master Account credential from the external key vault, configure external

credentials, or set to manual (switch modes of AD Master Account credential retrieval).

Retrieve auto-login credentials

Прим.:  This use case applies to both On-Premises and Cloud deployments.

Auto-login credentials are used to authenticate to an Automation 360 Bot Agent device and start an active
Windows session. Robotic Process Automation (RPA) requires an active Windows session to function. Auto-
login occurs prior to the automation running when automations are launched from a remote Bot Agent
device.
The following image shows the process of retrieving the auto-login credentials with Azure:
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A Control Room administrator can manually launch or schedule a job to launch an automation on a Bot
Agent device by specifying these details:
• Automation (бот) name
• Имя устройства
• User context

The system performs auto-login to the specified device with the user name and password associated with
the user context, and then runs the automation on the device.
You must have a secret for each Control Room user for whom the auto-login credentials will be retrieved
from the external key vault, and the secret name in the Azure Key Vault must match the Control Room
username.
To configure retrieval of auto-login credentials from the external key vault, perform these steps:
1. Log in to the Automation 360 Control Room as the Administrator.
2. From the Control Room, navigate to Administration > Settings > Devices.
3. Scroll down to the auto-login settings section and click Edit.
4. If you previously configured Azure Key Vault as the external key vault connection, click Enabled to

retrieve the auto-login credentials from that external key vault.
If this option is disabled, then the external key vault connection was not configured.

Прим.:  If you disable auto-login from the external key vault, then credentials are retrieved using the
AAI Credential Vault and its stored credentials instead.

5. The Azure Key Vault has a flat name space without any organizational containers, so you do not need
to enter a Safe name. Щелкните Сохранить изменения.

If successful, then the auto-login settings successfully saved message displays.

Auto-login naming conventions

The Control Room retrieves auto-login credentials based on the object naming convention within the
external key vault. The Control Room searches for an object where the object name (the credential name
in the external key vault) matches the Control Room username for which it is performing auto-login.
The prefix autologin_ is required as part of the naming convention for auto-login credentials for all
external key vaults: CyberArk, AWS, and Azure. The name of the auto-login credential in the external key
vault must contain autologin_ followed by the Control Room username. In some cases, certain key
vaults have restrictions on the characters that can be used in credential object names. Additionally, to
support how different use cases encode credentials, Automation 360 requires that certain characters be
reserved or encoded.
The following table lists examples of the object naming conventions expected in the Control Room:

Control Room username Expected object name format

ABCD\user123 autologin_ABCD--user123

user123@rpa.abcd.com autologin_user123-40-rpa-2e-abcd-2e-com

Прим.:  For On-Premises customers using AD authentication, you must format auto-login usernames
using the UPN format or domain\username postfix.
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For auto-login credentials, keep these in mind:
• The object name in the external key vault must contain autologin_ as a prefix.
• The auto-login credential names must map to the Control Room username (login ID) for the credential

being retrieved.
Some external key vaults have usage restrictions of certain characters, such as backslash (\) and
ampersand (@) in the secret name (object name), and restrictions on how special characters are
interpreted within API calls. If the user ID contains special characters, then you must encode the secret
name (object name) in the external key vault using ASCII code character substitutions, as listed in the
following table.

This character Changes to this ASCII code character
substitution

\ (backslash) --

- (dash) -2d-

_ (underscore) -5f-

@ (ampersand) -40-

. (period) -2e-

Прим.:  Except for the backslash being mapped to double dashes, the dash, period, underscore, and
ampersand are mapped using their ASCII code bracketed in dashes.

Azure auto-login credential example

For this auto-login credential retrieval example, consider a Control Room user who wants to deploy a бот
on a device as a specific user. This example uses the following details:
• Automation (бот) name run on a device = ProcureToPayGeoEast
• Agent device name = WinVDI1138
• Agent user context = rpauserCR1@abcd.com

The following image shows this an example of retrieving auto-login credentials with Azure:

© 2023 Automation Anywhere. All rights reserved.     2906



    Automation Anywhere - Управление

Before starting the automation, ensure the following:
1. The Control Room connection details have been successfully configured, and the Control Room uses

these connection details to connect to Azure and performs authentication.
2. The Control Room queries the Bot Agent device running on device WinVDI1138 to check if there is

an active Windows (operating system) session currently on device WinVDI1138, and if that session
belongs to Agent user rpauserCR1.
If there is an existing session on the device for user rpauserCR1, then there is no need to perform
auto-login and the бот continues with the deployment.

3. However, if there is an no active session or if there is an active session that does not belong to
rpauserCR1, then the Control Room retrieves the auto-login credential from the Azure Key Vault.

4. The Control Room passes the credential (password) to theBot Agent. The Bot Agent performs
a Windows login on device WinVDI1138 as rpauserCR1 (first, logging off any other
user login session) using the auto-login credential for rpauserCR1. The automation (Бот)
ProcureToPayGeoEast then starts to run on device WinVDI1138 as rpauserCR1.

Retrieve automation credentials

Прим.:  This use case applies to both On-Premises and Cloud deployments.

Automation credentials are variables used by бот developers within automation (бот) actions that
define and retrieve data from encrypted storage. The automation uses the credentials to authenticate to
applications (for example: finance application). Automation credentials are retrieved by the Automation
360 Bot Agent during runtime.
The following image shows the process of retrieving automation credentials with Azure:

Automation credentials retrieved from the Azure Key Vault are mapped in the Automation Anywhere
Credential Vault. The Credential Vault supports these two types of automation credentials:

System credentials Credentials where the value returned by the
credential variable is the same for any automation
that uses that variable.

User-defined credentials Credentials where the value returned by the
credential variable is distinct based on the user
context in which the automation is running.

For both system credentials and user-defined credentials, the бот developer specifies the same credential
variable within the бот code. Then, the system determines which credential to retrieve during бот runtime.
User-defined credentials simplify automation development by enabling бот developers to write code using
a single credential variable where the RPA platform substitutes the value returned during runtime with
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a unique user-specific value. Developers can avoid writing duplicate code with different user-specific
credential variables.
The following image shows the expected naming convention for Azure credentials:

The diagram shows six secrets in the Azure Key Vault which can be mapped to two credentials within the
Control Room Credential Vault
• Object3
• Object4

For example, you can map a ячейка in the Control Room to either prefixID3 or prefixID4. Then, you
map the secret to a credential. For each credential, the secrets will be consumed (retrieved by the Control
Room) as a system-defined credential (without username postfix) and two user-defined credentials (one
each for the Control Room users whose usernames are User1ID1 and User1ID2).

Прим.:  Within the Control Room Credential Vault, the name of the ячейка and the name of the credential
are arbitrary and local to the Control Room. You map these names to specific secrets in the external key
vault.

Within Azure Key Vault, each automation credential is stored with a name that contains specific identifiers
including: a prefix, object identifier, and an optional postfix which identifies a username. This is a required
naming convention that assures retrieval of the correct credential. The name of the secret (the credential)
in Azure Key Vault encodes information about the mapping within the Automation Anywhere Credential
Vault.
As an administrator, to map a Control Room to Azure Key Vault, you create and configure a ячейка and a
credential using the external key vault option within the Create Locker and Create Credential features
in the Automation 360 Control Room:
• You configure a ячейка in the Credential Vault to map to an Azure secret name prefix.
• You configure credentials in the Credential Vault that map to an Azure secret object identifier (optional

postfix for user-defined credential).

During runtime, the RPA platform retrieves the secret that is named with a postfix that matches the user
context (user-defined credential) in which the automation is running. If there is no user-defined credential,
then the RPA platform retrieves the secret without a username postfix (system credential).
The Control Room implements access controls to the external credentials through permissions within roles.
You control access to credentials by assigning different Control Room users to different roles and then
associating different ячейкаs with those roles.
The following image shows the Control Room Credential Vault ячейка and credential mapped to an Azure
secret:
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Важное замечание:  When creating an externally mapped credential, you must place the credential
in the appropriate externally mapped ячейка (the ячейка is mapped to the prefix in the secret name).
The Azure secret name will have a naming convention: Prefix + Secret_Name_Body + Postfix
(optional for user-defined credentials).

Прим.:  The same permissions and privileges (assigned through roles) in the Control Room apply to
credentials mapped to the external key vault.

Automation naming conventions

The following table shows Azure Key Vault external key vault examples using naming conventions for
automation.

Прим.:  The Azure Prefix maps to the locker for the Control Room, and the Azure Secret Body maps to the
credential for the Control Room.

Automation
credential
example

Azure Prefix Azure Secret Body Secret in Azure Control Room
username

accounting_cv1
System credential
in locker mapped
to Azure Secret
name prefix
accounting

accounting cv1 pdf-5f-cv1
(system)

None - system
credential

accounting_cv1_ABCD
\user123
User-defined
credential in locker
mapped to Azure
prefix

accounting cv1 pdf-5f-cv1-5f-
ABCD--user123

ABCD\user123
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When deploying Azure credentials, the Azure Key Vault character underscore (_) is a reserved character
and cannot be used in credential names. You must substitute any underscore (_) usage with the ASCII
code value 5f bracketed by dashes:

This character Changes to this ASCII code character
substitution

\ (slash) --

- (dash) -2d-

_ (underscore) -5f-

@ (ampersand) -40-

. (period) -2e-

Azure automations credentials retrieval example

To configure automation credentials retrieval and integrate with the Azure Key Vault, you first create a
ячейка and then create credentials.
To create a ячейка to integrate with the Azure Key Vault, perform these steps:
1. From the Automation 360 Control Room, navigate to Manage > Credential.

A user with Manage my credentials and ячейки permissions is authorized to create credentials.
2. From the Credentials tab, select Create Locker.
3. Enter a name for the ячейка (for example, Locker3).

This name is local to the Control Room and does not have any dependency on the Azure secret name.
4. Click External Key Vault and enter the Azure secret name prefix (for example: prefixID3). You

must name secrets within the Azure Key Vault using the name prefix for the configuration of the
mapping to complete successfully.

5. Щелкните Вперед.
6. Configure Owners, Managers, Participants, and Consumers for the ячейка.
7. Click Create locker.

См. раздел Создать ячейка.

The Control Room is now ready to retrieve credentials and enforce access controls on all Azure secrets with
the prefix prefixID3. To continue, you now create the credentials.
To create a credential to integrate with the Azure Key Vault, perform these steps:
1. From the Automation 360 Control Room, navigate to Manage > Credentials.

A user with Manage my credentials and ячейки permissions is authorized to create credentials.
2. From the Credentials tab, select Create Credential.
3. Enter the credential name in the Credential name field.

This name is local to the Control Room and does not have any dependency on the Azure secret name.
4. Click External key vault below the name field.
5. From the list of available ячейки, select the appropriate ячейка that was previously mapped to the

secret name prefix for the secrets you are now mapping to the credential.
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6. Enter the Azure Secret_Name_Body in the Secret name field (for example: Object3).
7. Click Validate and retrieve attributes.

The system validates the mapping by attempting to retrieve from the Azure Key Vault a secret with the
name Prefix_Secret_Name_Body (for example: prefixID3_Object3.
If validation fails, then no secret exists in the Azure Key Vault with the name that matches the
combination of ячейка (prefix) and credential (Secret_Name_Body). In this example, there is no
secret in the Azure Key Vault named prefixID3_Object3.
When the system successfully retrieves the secret, it will display the Azure Key Vault secret attributes
(the fields within the secret).

8. From the list of attributes, select attributes to map to the credential.
9. Click Create credential.

If successful, then the credential successfully created message displays.

Integrating AWS Secrets Manager with Automation 360
You integrate the Automation 360Control Room to retrieve credentials from the AWS Secrets Manager.
The credentials become resident within the AWS Secrets Manager where they are managed, rotated, and
synchronized.
You can integrate Automation 360 with the AWS Secrets Manager using either of these deployments:
• Cloud
• On-Premises

The following diagram shows an Automation 360 Cloud deployment where with AWS Secrets Manager:
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For On-Premises deployments, you deploy the following:
• Control Room as software within your customer environment.
• Bot Agent within your customer environment where automations run and access customer applications.

Важное замечание:  You can edit the external key vault connection settings through the user interface
in Cloud deployments only. External key vault settings in On-Premises deployments are only configurable
during installation or with the key vault utility post-installation. Customers will need to ensure connectivity
to the external key vaults from their On-Premises deployed Control Room instances.

On-Premises integration using AWS Secrets Manager
As an Automation 360 administrator, you can configure the AWS On-Premises integration using one of
these methods: initial installation or post-installation using a command-line interactive key vault utility.
Within the On-Premises installation wizard, bootstrap credential retrieval from external key vault
configuration options are only available if you first configure the key vault connection. The configuration
options vary based on the external key vault you select.
Choose your integration method:
• Initial installation
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• Post-installation using key vault utility

On-Premises initial installation using AWS Secrets Manager
Using the initial installation method, you can connect and configure the external key vault connector,
service account credential (Active Directory master password), and bootstrap (database) credential
identifier.

Прим.:  You must select Microsoft SQL Server Authentication as the database; other database
authentication methods are not supported for this use case.

You can configure the SMTP and AD credential identifier to retrieve from the external key vault using the
Automation 360 user interface.
1. Configure the AWS Secrets Manager requirements from the AWS Administrative Console.
2. Integrate the AWS Secrets Manager and Automation 360 Control Room.
3. Set up the authentication type for Automation 360 Control Room users and the AWS Secrets Manager.

After you successfully complete the initial installation, the Automation 360 Control Room can access and
retrieve credentials within the AWS Secrets Manager.
Configure AWS Secrets Manager requirements for initial installation
Before you can integrate the Automation 360 Control Room with the AWS Secrets Manager, you must
configure AWS Secrets Manager requirements using the AWS Administrative Console.
1. Use the AWS Administrative Console to collect these AWS environment variables which you must set in

the environment of the Control Room Server Microsoft Operating System:
• AWS_ACCESS_KEY_ID
• AWS_SECRET_ACCESS_KEY
• AWS_SESSION_TOKEN

2. After you set the environment variables in AWS, you must then add them to the Server Environment

on the Automation 360 Control Room:
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The AWS Secrets Manager has a flat name space with no organizational containers. There is no safe or
locker within the AWS Secrets Manager and all credentials are stored together in the same container.
Credentials are stored in objects which only have a secret name.
Integrate AWS Secrets Manager and Control Room
After you configured the AWS Secrets Manager requirements using the AWS Administrative Console, you
can integrate the AWS Secrets Manager and the Automation 360 Control Room.

1. After you start the Automation 360 installation wizard, select On-premises as the Deployment
Option and click Next.

2. Accept the license agreement and click Next.
3. Select Custom as the Installation Type Preference and click Next.
4. Accept the default locations for the destination folders and click Next.
5. To connect and configure the external key vault integration, select AWS Secret

Manager.
6. In the Region field, enter the AWS region code (for example: us-east1 and click Next.
7. Accept the default settings from the TLS Configuration dialog box and click Next.
8. Accept the default settings from the Service Credentials dialog box, and click Next.
9. From the Database Authentication dialog box, select an option to specify the Secret name from

AWS instead of manually entering the secret name the Control Room uses to authenticate to the

database.
a) Click SQL Server authentication (retrieve credential from external key vault), and then

enter the Secret Name value.
b) Click Next to continue and complete the initial installation. The installer will query AWS Secrets

Manager for the credential to validate that the secret exists.

After you successfully complete the initial installation, the Automation 360 Control Room can access and
retrieve credentials within the AWS Secrets Manager.
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Set up authentication type for AWS Secrets Manager
After you complete the initial installation and configure AWS Secrets Manager as the external key vault,
you can set up the authentication type for Automation 360 Control Room users in the Initial Setup (this
occurs directly after the initial installation completes).
1. From the Authentication type for Control Room users dialog box, click Active

Directory.
2. You can optionally configure the Active Directory integration credential (this is the credential that the

Control Room uses to authenticate users with Active Directory) to be retrieved from AWS Secrets
Manager. Click External Key vault and enter the AWS secret to retrieve credentials in the field (for
example: userAD). The Control Room will attempt to retrieve the credential from the AWS Secrets
Manager and then authenticate to the Domain Controller. If this fails either:
• There is no secret with that name in AWS Secrets Manager, or
• There is a secret with that name, but it does not contain a username and password that is

authorized for authentication with Active Directory.

3. Click Discover connections. The available domains and sites display.
4. Click Next and continue to create the Control Room first admin. Save the Admin user information.

You can now log in to the Control Room as admin and add users and roles.

On-Premises post-installation using AWS Secrets Manager
You use the command-line interactive key vault utility during a scheduled system downtime
and you must stop all running Control Room services. You should coordinate any key vault
configuration changes that might impact connectivity parameters (such as AWS_ACCESS_KEY_ID,
AWS_SECRET_ACCESS_KEY, and AWS_SESSION_TOKEN) during downtimes with the AWS administrative
team.

Прим.:  If you use the key vault utility to disable AWS Secrets Manager integration, you must first unmap
any mapped credentials that are in use.

Using the post-installation method, you can perform these actions:
• Modify or configure the external key vault connection parameters.
• (If not configured during initial installation) Modify or configure the service account credential (Active

Directory master password).
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• (If not configured during initial installation) Modify or configure the database (bootstrap) credential
identifier (retrieved when authenticating the database).

Прим.:  Retrieving bootstrap credentials from an external key vault might cause the Control Room
to fail if the external key vault is not accessible during boot-up, or if the external key vault is not
accessible when the Control Room refreshes database connections and authenticates users with Active
Directory.

• Recover the Control Room for these reasons:
• By modifying the external key vault connection parameters, the service account, and database

credential safe and object identifiers.
• If AWS Secrets Manager connection parameters changes caused the Control Room to experience

connectivity issues.
• When credential identifiers for bootstrap passwords change.

You can address any initial configuration settings that were not set correctly and recover the system.

You can configure and edit SMTP and AD credential identifiers to retrieve information from the external
key vault from the Automation 360 Control Room by navigating to Administration > Settings > Active
Directory.
1. Run the key vault utility for the AWS Secrets Manager: To run the key vault utility and update

key vault connection settings:
a) As the Control Room administrator, access the Automation Anywhere Control Room installation

directory that was created during the initial Automation 360 installation.
Пример. C:\Program Files\Automation Anywhere\Enterprise

b) Download the latest version of the key vault utility. To download the jar file used to update the
directory, open a browser and access the A-People site: A-People Downloads page (Login required).

Прим.:  If DB authentication is configured to use external key vault, the utility returns the
following exception: Database currently configured to retrieve credentials
 from key vault. Update database authentication to WINDOWS/SQL to
 proceed further and exit.

The utility requests the user to confirm the action: Disable/update of key vault might
 impact functionalities using key vault (for example, Active Directory
 configuration, Email Settings configuration). Make sure to update these
 settings (if any). Are you sure you want to continue?

c) Enter Y to continue.
d) Enter the following:

> jdk11\bin\java -jar certmgr.jar -appDir . -importTrustCert <Full path
 of the certificate>

e) Add these jvm arguments to the command to run the key vault utility:
1. -Djavax.net.ssl.trustStore="C:\Program Files\Automation Anywhere

\Enterprise\pki\trust\store.ks"

2. -Djavax.net.ssl.trustStorePassword=changeit --module-path lib -
jar crutils.jar -configPath "C:\Program Files\Automation Anywhere
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\Enterprise\config" -action [UPDATE_KEY_VAULT_CONFIGURATION or
 UPDATE_DB_AUTHENTICATION_CONFIGURATION]

You can update either of these configuration actions:
• Enter UPDATE_KEY_VAULT_CONFIGURATION to edit the AWS Secrets Manager configuration.
• Enter UPDATE_DB_AUTHENTICATION_CONFIGURATION to change to database

authentication using external key vault.

2. Based on which configuration action you used, choose the appropriate action:
• Update key vault configuration for AWS: If you entered

UPDATE_KEY_VAULT_CONFIGURATION as the configuration action:
a. After the utility loads the current key vault configuration and properties, and this prompt is

displayed: Enter key vault [AWS/CYBERARK/AZURE/NONE] :, enter AWS
b. At the Please enter Vault URL: prompt, enter (for example): https://

services.uscentral.skytap.com:19516

The key vault utility runs. If the configuration was successful (the utility was able to connect to the
external key vault using the configured parameters), these messages are displayed on the console:

Connection configurations valid
  Key Vault configurations successfully updated

• Update database authentication for AWS: If you entered
UPDATE_DB_AUTHENTICATION_CONFIGURATION as the configuration action:
a. After the utility loads the current database configuration information, this prompt is displayed:

Database authentication configurations loaded
Currently configured database authentication [SQL]

Change database authentication. Available options:
WINDOWS: Connect to database using windows authentication
SQL: Connect to database using SQL server authentication, manually
 enter username and password
KEY_VAULT: Connect to database using SQL server authentication,
 retrieve username and password from external key Vault 

Enter database authentication [WINDOWS/SQL/KEY_VAULT]:

Enter KEY_VAULT
b. At the Please enter Secret name: prompt, enter (for example): testDB

The key vault utility runs. If the database configuration was successful (the utility was able to
connect to AWS, retrieve the designated credential and then use the credential to connect to the
database), these messages display on the console:

Database Credentials are valid
Database authentication configurations successfully updated
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Cloud integration using AWS Secrets Manager
For Cloud integrations, you can configure the Control Room and external key vault integration using the
Automation 360 Control Room user interface.
The Agent auto-login and Agent automation use cases are only supported on Automation 360 Cloud
Control Room instances. Neither of these use cases affect the Control Room boot sequence or Control
Room functionality.

Прим.:  Bootstrap and service account credential retrieval use cases are not supported on Cloud Control
Room instances because the database and services are managed internally by Automation Anywhere.
There is no compliance use case (requirement) for these credentials to be stored in the customer external
key vault.

1. Gather the specific AWS information required to configure the external key vault connector using the
Automation 360 Control Room.

Элемент Описание

AWS_ACCESS_KEY_ID The AWS environment variable that specifies
an AWS access key associated with an IAM
user or role.

AWS_SECRET_ACCESS_KEY The AWS environment variable that specifies
the secret key associated with the access
key.

AWS_SESSION_TOKEN The AWS environment variable that specifies
the session token value that is required
if you use temporary security credentials
retrieved directly from AWS operations.

Область A separate geographic area that AWS uses
to house its infrastructure.

2. Log in to the Automation 360 Control Room as the Administrator.
3. From the Control Room, navigate to Administration > Settings > External key vault.
4. Click the Edit icon to open the Configuration settings pane.
5. Click AWS and then enter the specific AWS information described in the preceding table.
6. Click Save changes to connect the external key vault.

AWS credential retrieval use cases
You can retrieve AWS credentials for these use cases: bootstrap, system, auto-login, and automations.

Retrieve Control Room bootstrap credentials

Прим.:  This use case applies to On-Premises deployments only.

The Automation 360 Control Room uses bootstrap credentials to access supporting services such as
database, service account, and Active Directory (AD). You configure these credentials during the initial On-
Premises installation or post-installation (using the key vault utility) by specifying the object name.
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The following image shows the process of retrieving the Control Room bootstrap credentials with AWS:

When required during the bootup sequence or normal operations (such as refreshing a service
authentication), the Control Room uses the key vault connection to retrieve the credential and perform the
required authentication.

Прим.:  You must select the Microsoft SQL Server Authentication for this use case; other database
authentication methods are not supported for bootstrap.

Retrieve Control Room system credentials

Прим.:  This use case applies to On-Premises deployments only, and you can configure the service
account only during the initial installation.

If you configured an external key vault during the initial installation, you can then use the Automation 360
user interface (post-installation) to configure SMTP and Active Directory (AD) credentials.
1. Log in to the Automation 360 Control Room as the Administrator.
2. From the Control Room, navigate to: Administration > Settings > Email Settings.
3. You can map the AD Master Account credential from the external key vault, configure external

credentials, or set to manual (switch modes of AD Master Account credential retrieval).

Retrieve auto-login credentials

Прим.:  This use case applies to both On-Premises and Cloud deployments.

Auto-login credentials are used to authenticate to an Automation 360 Bot Agent device and start an active
Windows session. Robotic Process Automation (RPA) requires an active Windows session to function. Auto-
login occurs prior to the automation running when automations are launched from a remote Bot Agent
device.
The following image shows the process of retrieving the auto-login credentials with AWS:
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A Control Room administrator can manually launch or schedule a job to launch an automation on a Bot
Agent device by specifying these details:
• Automation (бот) name
• Имя устройства
• User context

The system performs auto-login to the specified device with the user name and password associated with
the user context, and then runs the automation on the device.
You must have a secret for each Control Room user for whom the auto-login credentials will be retrieved
from the external key vault, and the secret name in the AWS Secrets Manager must match the Control
Room username.
To configure retrieval of auto-login credentials from the external key vault, perform these steps:
1. Log in to the Automation 360 Control Room as the Administrator.
2. From the Control Room, navigate to Administration > Settings > Devices.
3. Scroll down to the auto-login settings section and click Edit.
4. If you previously configured AWS Secrets Manager as the external key vault connection, click Enabled

to retrieve the auto-login credentials from that external key vault.
If this option is disabled, then the external key vault connection was not configured.

Прим.:  If you disable auto-login from the external key vault, then credentials are retrieved using the
AAI Credential Vault and its stored credentials instead.

5. The AWS Secrets Manager has a flat name space without any organizational containers, so you do not
need to enter a Safe name. Щелкните Сохранить изменения.

If successful, then the auto-login settings successfully saved message displays.

Auto-login naming conventions

The Control Room retrieves auto-login credentials based on the object naming convention within the
external key vault. The Control Room searches for an object where the object name (the credential name
in the external key vault) matches the Control Room username for which it is performing auto-login.
The prefix autologin_ is required as part of the naming convention for auto-login credentials for all
external key vaults: CyberArk, AWS, and Azure. The name of the auto-login credential in the external key
vault must contain autologin_ followed by the Control Room username. In some cases, certain key
vaults have restrictions on the characters that can be used in credential object names. Additionally, to
support how different use cases encode credentials, Automation 360 requires that certain characters be
reserved or encoded.
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The following table lists examples of the object naming conventions expected in the Control Room:

Control Room username Expected object name format

ABCD\user123 autologin_ABCD--user123

user123@rpa.abcd.com autologin_user123-40-rpa-2e-abcd-2e-com

Прим.:  For On-Premises customers using AD authentication, you must format auto-login usernames
using the UPN format or domain\username postfix.

For auto-login credentials, keep these in mind:
• The object name in the external key vault must contain autologin_ as a prefix.
• The auto-login credential names must map to the Control Room username (login ID) for the credential

being retrieved.
Some external key vaults have usage restrictions of certain characters, such as backslash (\) and
ampersand (@) in the secret name (object name), and restrictions on how special characters are
interpreted within API calls. If the user ID contains special characters, then you must encode the secret
name (object name) in the external key vault using ASCII code character substitutions, as listed in the
following table.

This character Changes to this ASCII code character
substitution

\ (backslash) --

- (dash) -2d-

_ (underscore) -5f-

@ (ampersand) -40-

. (period) -2e-

Прим.:  Except for the backslash being mapped to double dashes, the dash, period, underscore, and
ampersand are mapped using their ASCII code bracketed in dashes.

AWS auto-login credential example

For this auto-login credential retrieval example, consider a Control Room user who wants to deploy a бот
on a device as a specific user. This example uses the following details:
• Automation (бот) name run on a device = ProcureToPayGeoEast
• Agent device name = WinVDI1138
• Agent user context = rpauserCR1@abcd.com

The following image shows this an example of retrieving auto-login credentials with AWS:
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Before starting the automation, ensure the following:
1. The Control Room connection details have been successfully configured, and the Control Room uses

these connection details to connect to AWS and performs authentication.
2. The Control Room queries the Bot Agent device running on device WinVDI1138 to check if there is

an active Windows (operating system) session currently on device WinVDI1138, and if that session
belongs to Agent user rpauserCR1.
If there is an existing session on the device for user rpauserCR1, then there is no need to perform
auto-login and the бот continues with the deployment.

3. However, if there is an no active session or if there is an active session that does not belong to
rpauserCR1, then the Control Room retrieves the auto-login credential from the AWS Secrets
Manager.

4. The Control Room passes the credential (password) to theBot Agent. The Bot Agent performs
a Windows login on device WinVDI1138 as rpauserCR1 (first, logging off any other
user login session) using the auto-login credential for rpauserCR1. The automation (Бот)
ProcureToPayGeoEast then starts to run on device WinVDI1138 as rpauserCR1.

Retrieve automation credentials

Прим.:  This use case applies to both On-Premises and Cloud deployments.

Automation credentials are variables used by бот developers within automation (бот) actions that
define and retrieve data from encrypted storage. The automation uses the credentials to authenticate to
applications (for example: finance application). Automation credentials are retrieved by the Automation
360 Bot Agent during runtime.
The following image shows the process of retrieving automation credentials with AWS:
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Automation credentials retrieved from the AWS Secrets Manager are mapped in the Automation Anywhere
Credential Vault. The Credential Vault supports these two types of automation credentials:

System credentials Credentials where the value returned by the
credential variable is the same for any automation
that uses that variable.

User-defined credentials Credentials where the value returned by the
credential variable is distinct based on the user
context in which the automation is running.

For both system credentials and user-defined credentials, the бот developer specifies the same credential
variable within the бот code. Then, the system determines which credential to retrieve during бот runtime.
User-defined credentials simplify automation development by enabling бот developers to write code using
a single credential variable where the RPA platform substitutes the value returned during runtime with
a unique user-specific value. Developers can avoid writing duplicate code with different user-specific
credential variables.
The following image shows the expected naming convention for AWS credentials:

The diagram shows six secrets in the AWS Secrets Manager which can be mapped to two credentials
within the Control Room Credential Vault
• Object3
• Object4

For example, you can map a ячейка in the Control Room to either prefixID3 or prefixID4. Then, you
map the secret to a credential. For each credential, the secrets will be consumed (retrieved by the Control
Room) as a system-defined credential (without username postfix) and two user-defined credentials (one
each for the Control Room users whose usernames are User1ID1 and User1ID2).
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Прим.:  Within the Control Room Credential Vault, the name of the ячейка and the name of the credential
are arbitrary and local to the Control Room. You map these names to specific secrets in the external key
vault.

Within AWS Secrets Manager, each automation credential is stored with a name that contains specific
identifiers including: a prefix, object identifier, and an optional postfix which identifies a username. This
is a required naming convention that assures retrieval of the correct credential. The name of the secret
(the credential) in AWS Secrets Manager encodes information about the mapping within the Automation
Anywhere Credential Vault.
As an administrator, to map a Control Room to AWS Secrets Manager, you create and configure a ячейка
and a credential using the external key vault option within the Create Locker and Create Credential
features in the Automation 360 Control Room:
• You configure ячейкаs in the Credential Vault that map to an AWS secret name prefix.
• You configure credentials in the Credential Vault that map to an AWS secret object identifier (optional

postfix for user-defined credential).

During runtime, the RPA platform retrieves the secret that is named with a postfix that matches the user
context (user-defined credential) in which the automation is running. If there is no user-defined credential,
then the RPA platform retrieves the secret without a username postfix (system credential).
The Control Room implements access controls to the external credentials through permissions within roles.
You control access to credentials by assigning different Control Room users to different roles and then
associating different ячейкаs with those roles.
The following image shows the Control Room Credential Vault ячейка and credential mapped to an AWS
secret:

Важное замечание:  When creating an externally mapped credential, you must place the credential in
the appropriate externally mapped ячейка (the ячейка is mapped to the prefix in the secret name). The
AWS secret name will have a naming convention: Prefix + Secret_Name_Body + Postfix (optional
for user-defined credentials).

Прим.:  The same permissions and privileges (assigned through roles) in the Control Room apply to
credentials mapped to the external key vault.
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Automation naming conventions

The following table shows AWS Secrets Manager external key vault examples using naming conventions for
automation.

Прим.:  The AWS Prefix maps to the locker for the Control Room, and the AWS Secret Body maps to the
credential for the Control Room.

Automation
credential
example

AWS Prefix AWS Secret Body Secret in AWS Control Room
username

accounting_pdf
System credential
in locker mapped
to AWS Secret
name prefix
accounting

accounting pdf accounting_pdf
(system)

None - system
credential

accounting_pdf_ABCD--
user123
User-defined
credential in
locker mapped
to AWS Secret
Name prefix
accounting

accounting pdf accounting_pdf_ABCD--
user123

ABCD\user123

AWS automations credentials retrieval example

To configure automation credentials retrieval and integrate with the AWS Secrets Manager, you first create
a ячейка and then create credentials.
To create a ячейка to integrate with the AWS Secrets Manager, perform these steps:
1. From the Automation 360 Control Room, navigate to Manage > Credential.

A user with Manage my credentials and ячейки permissions is authorized to create credentials.
2. From the Credentials tab, select Create Locker.
3. Enter a name for the ячейка (for example, Locker3).

This name is local to the Control Room and does not have any dependency on the AWS secret name.
4. Click External Key Vault and enter the AWS secret name prefix (for example: prefixID3). You

must name secrets within the AWS Secrets Manager using the name prefix for the configuration of the
mapping to complete successfully.

5. Щелкните Вперед.
6. Configure Owners, Managers, Participants, and Consumers for the ячейка.
7. Click Create locker.

См. раздел Создать ячейка.
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The Control Room is now ready to retrieve credentials and enforce access controls on all Azure secrets with
the prefix prefixID3. To continue, you now create the credentials.
To create a credential to integrate with the AWS Secrets Manager, perform these steps:
1. From the Automation 360 Control Room, navigate to Manage > Credentials.

A user with Manage my credentials and ячейки permissions is authorized to create credentials.
2. From the Credentials tab, select Create Credential.
3. Enter the credential name in the Credential name field.

This name is local to the Control Room and does not have any dependency on the AWS secret name.
4. Click External key vault below the name field.
5. From the list of available ячейки, select the appropriate ячейка that was previously mapped to the

secret name prefix for the secrets you are now mapping to the credential.
6. Enter the AWS Secret_Name_Body in the Secret name field (for example: Object3).
7. Click Validate and retrieve attributes.

The system validates the mapping by attempting to retrieve from the AWS Secrets Manager a secret
with the name Prefix_Secret_Name_Body (for example: prefixID3_Object3.
If validation fails, then no secret exists in the AWS Secrets Manager with the name that matches the
combination of ячейка (prefix) and credential (Secret_Name_Body). In this example, there is no
secret in the AWS Secrets Manager named prefixID3_Object3.
When the system successfully retrieves the secret, it will display the AWS Secrets Manager secret
attributes (the fields within the secret).

8. From the list of attributes, select attributes to map to the credential.
9. Click Create credential.

If successful, then the credential successfully created message displays.

Changing external key vault to another
If you did not integrate the external key vault during the initial installation and you want to configure it
without re-installing, you must use the key vault utility. Also, to change the external key vault connection
details or to change the bootstrap credentials, you must use the key vault utility.
You use the key vault utility for each of these scenarios:
• To initially configure the external key vault connection if it was not configured during initial installation

and you do not want to re-install the external key vault.
• To change external key vault connection details:

• Example 1: CyberArk Password Vault is migrating to a server with a different name
• Example 2: CyberArk Password Vault authentication certificate is changing
• Example 3: You want to change from one AWS Secrets Manager instance to another
• Example 4: You want to change from one Azure Key Vault instance to another

• The Automation 360 Control Room is malfunctioning because the external key vault connection has
changed, and the Control Room is no longer able to retrieve credentials from the external key vault.

• The Control Room is malfunctioning because the credentials defined for bootstrap or Active Directory
integration have changed names.
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• To change the KEY_VAULT from one external key vault to another, or to NONE, you must first manually
set the database and service account credentials that are currently being retrieved from the external
key vault.
For example, to change from an AWS Secrets Manager key vault to a CyberArk Password Vault, you
must perform these actions:
1. Set the external KEY_VAULT attribute to NONE.
2. Set the external key vault to the new key vault type.

This following table provides guidelines on acceptable state changes for the KEY_VAULT attribute:

Original key vaultNew key vault

AWS CyberArk Azure Нет

AWS Да Нет Нет Да

CyberArk Нет Да Нет Да

Azure Нет Нет Нет Да

Нет Да Да Да Да

• To change from an AWS Secrets Manager key vault to a CyberArk Password Vault (or vice-versa), you
must first change the KEY_VAULT attribute to NONE.

• To change an AWS Secrets Manager key vault or a CyberArk Password Vault to NONE, ensure that the
database is not connected with the KEY_VAULT attribute.

Verify external key vault configuration
Use the Automation 360 Control Room to verify external key vault configuration and database
authentication changes you made using the key vault utility.
1. Log in to the Automation 360 Control Room as the administrator.
2. Go to Administration > Settings > General > Configuration settings.
3. Go to the Control Room Database & Software tab and scroll down to the Control Room database

information to verify its details.
4. Navigate back to Settings > External key vault and review its configuration settings for external

vault, vault URL, and Application ID.
5. Navigate back to Settings > Email, and click the Edit icon to open the Notifications pane.
6. Scroll down to verify that the external key vault settings reflect the SMTP credential identifier in the

external key vault
7. Щелкните Закрыть.

Troubleshooting external key vaults
You can use the keyvault.properties file and application log files to review configuration and
integration information for external key vaults.

© 2023 Automation Anywhere. All rights reserved.     2927



    Automation Anywhere - Управление

Use the keyvault.properties file

You can use the keyvault.properties file to review configuration attributes for these external key
vaults:
• CyberArk Password Vault
• Диспетчер секретов AWS
• Хранилище ключей Azure

The following keyvault.properties file shows an example with the CyberArk Password Vault:

To review the AWS Secrets Manager keyvault.properties file, enter these AWS attributes (for
example):
• keyvault.type=AWS_SECRETS_MANAGER
• keyvault.aws.region=us-west-2

Прим.:
• The certificate passphrase attribute contains the encrypted Control Room certificate file passphrase. Do

not modify the certificate passphrase attribute directly; instead, you should use the key vault utility.
• You can modify the keyvault.properties file. However, any modifications will require a service

restart. So we recommend that you always use the key vault utility to make modifications.

Use the application log files

You can use these application log files to review external key vault integration information:
• WebCR_CredentialVaultlog
• WebCR_RestException

You can use these log messages to troubleshoot external key vault integration or configuration issues:

Log message description Cause or reason

Unable to send an email
Невозможно подключиться к SMTP-серверу,
так как ваше имя пользователя или пароль
SMTP неверны.

Retrieved SMTP credential is incorrect.

Logs indicate failure connecting to LDAP Failure to authenticate through Active Directory.

WebCR.log file shows database connectivity
error, and the Control Room fails to boot up
correctly

Retrieved database password is incorrect.

© 2023 Automation Anywhere. All rights reserved.     2928



    Automation Anywhere - Управление

Log message description Cause or reason

Either your username or your password is
incorrect

Retrieved auto-login credential is incorrect for
the user (correlates to the бот deployment log
for user ID).

Logs indicate connection failure to CyberArk A possible certificate expiry issue exists if failure
occurs after a period of proper functioning for (3,
6, or 12) months.

A non-existent credential identifier (safe name,
object name, or secret name) is in use. Might
also indicate the credential identifier was
removed from the external key vault (if it was
previously working properly).

Unable to retrieve secret, and detail exception
will have cause

Might also indicate that the key vault connection
is down or unreachable. Or, connection details
(API URL, AppID, certificate, region name, AWS
keys) are incorrect, have been changed on the
key vault, or expired.

Уведомления
Notifications is a built-in mechanism in the Automation 360 Control Room, which notifies users about
various events. It is a centralized notifications repository in Automation 360 for all users to track relevant
events.
The Notifications mechanism provides simplified information about possible risks, warnings, information,
and success statistics of the Automation 360 platform and automation events. With the notifications
feature, you can monitor, respond, reduce, and resolve critical risks in much quicker way. It allows you
enable required event categories and be notified for the enabled events.
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Преимущества

Notifications provide the following benefits:
• Maintain all the notifications from a centralized repository.
• Enhance ability to respond to critical or warning notifications.
• Stay organized with automated notifications to reduce and avoid future risks, and take possible actions.
• Improve productivity of users and the platform by being notified about updates such as Бот export and

add or update package.
• Save time and increase notification efficiency because of a single centralized events repository.
• Increase relevance of notifications delivery through multichannel communication.
• Notify Automation 360 users about events through email report or instant email notification.

See the following video for an overview of how notifications are configured in the Automation 360 Control
Room:

Предварительные условия

• The Control Room administrator must enable the Administration > Settings > Notification
settings to receive notifications. Подробнее см. в разделе Administer notifications for Control Room.

• Control Room users must enable the required settings from the Notifications repository to receive
notifications. Подробнее см. в разделе Enable or disable event categories.
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Компоненты

• Notification icons and navigation:
•

: Indicates no new notification.
•

: Indicates new notification.
•

: Indicates hover over action on the notification icon.
•

: Indicates select action on the notification icon.

• Notifications panel:
The in-app notification panel provides a comprehensive view of all the event notifications with
notification summary and details. Подробнее см. в разделе Getting started with Notifications.

• Severities:
The in-app notification panel displays and categorizes all notification information in the following
severities:

Критический Notifies about high-risk events, which can stop or
impact execution of scheduled tasks or processes.

Предупреждение Notifies about cautionary events, which can
be interrupted, not running as expected, or
completed with minor recoverable errors.

Информация Notifies about platform or functionality updates,
such as updates to packages and бот export.

Успешно Notifies about events that are completed
successfully.

• Settings:
Enable and disable the notifications for Automation runtime events and Platform events. You can
also enable Email report channel to receive notifications through email.

Getting started with Notifications
The notifications repository provides simplified information that users can track for possible risks, warnings,
and success statistics of various Automation 360 events.
When you enable required event categories, you receive notifications through the notifications repository.

New notifications display with the ( ) icon.
To start working with notifications, set preferences for the following event categories and notification
channels:
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Event categories

Events are at the core of the monitoring framework. Users must be able to monitor event continuously,
and receive constant notifications. Automation 360 provides notifications for the following events:

Automation events This category notifies you about бот-related events.
These event notifications are sent to users based
on the permissions defined in the Automation 360
platform, and those users who have performed
specific tasks, such as export бот.
The following table lists examples of the automation
event and its severity:

Event
name

Severity Users
notified
for the
event

Type of
email
notifications

Бот export
successful

Успешно Control
Room
user who
exported
the бот

Email
report

Бот export
unsuccessful

КритическийControl
Room
user who
exported
the бот

Email
report

The following example shows an export бот event
notification with the Success severity:
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Platform events This category notifies you about events related
to the Automation 360 updates. These event
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notifications are sent to users based on their role
and permissions defined in the Control Room.
The following table lists an example of platform
events and their severity:

Event
name

Severity Users
notified
for the
event

Type of
email
notifications

Add or
update
пакет

Успешно All Control
Room
users

Email
report

Notification channels

Notifications are sent through integrated channels used to organize and manage the notifications.
Automation 360 send notifications through the following channels:

Notifications panel This is the default notification channel. The
notifications panel provides a summarized view of
all event notifications. It categorizes notifications
based on severity, and then sorts them in each
category by date showing the most recent
notification first. The count on each severity tab
(Critical, Warning, Info, and Success) shows
the number of unread notifications. Подробнее см.
в разделе Notification summary and details.

Прим.:  These notifications are available in the
Control Room for maximum of seven days.

Email notifications These notifications generate emails to the opted-
in users only. There are two types of email
notifications:
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• Instant notifications: Instant email
notification is sent to a user's registered email
address.
The following sample shows an email sent for an
instant notification:
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• Email report: Email report notification is sent
to a user's registered email address twice a day
at a fixed time.
The following sample shows an email sent for an
email report:

Прим.:  Notifications that are sent as Instant
notifications are not included in the Email
report and vice-versa. Based on the event
type, notifications are sent either as Instant
notifications, or Email report. You cannot
configure these notifications.

Notification summary and details

After you enable the required event category, corresponding event notifications are sent through the
Notifications repository. By expanding the notification summary, you can view the notification details.
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Прим.:  Every event notification does not have notification details. Sometimes the notification summary
provides all of the event information, for example, notifications about package updates with the Info
severity.

The following image is a sample event notification with Success severity:
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The following table describes the fields in the sample event notification (as numbered in the previous
example):
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Field/Option Описание

1 Event severity

2 Notification summary

3 Notification details

4 Event description

5 Exported or archived file name

Прим.:  This field and description varies based on the event
severity.

6 Event start date with time stamp

7 Event end date with time stamp

8 Message that describes the root cause of the event and next
possible action (if applicable) to take

Прим.:  The notification summary and details information varies based on the event type and severity.

Administer notifications for Control Room
As an administrator, you can manage notifications for the Control Room by enabling various notification
categories and channels.
Login to Control Room as an administrator.
You can manage notification settings for all the Control Room users and view the audit log information to
track user activities.

Прим.:  All the event categories are disabled by default.

1. Navigate to Administration > Settings > Notification settings.
2. To enable or disable the required event categories, click Edit.
3. Enable the required event categories. For more information about which event category to enable, see

Event categories.
4. Щелкните Сохранить изменения.

Прим.:  Notifications audit logs to track user activities are available at the Administration > Audit
log page. Подробнее см. в разделе Журнал аудита.

Manage notification channels
As a Control Room administrator, you can manage notification channels through which you want to notify
all the Control Room users.
• Login to Control Room as an administrator.
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• For On-Premises users, navigate to Administration > Settings > Email and enter an email address
in the From this email address field to manage emails. Подробнее см. в разделе Редактирование
уведомлений по электронной почте.

Прим.:  This setting does not apply to Cloud users. The region-specific email addresses deliver the
notifications in their respective clouds.

After you enable the required event categories, enable the required notification channel through which
Control Room events are notified to the opted-in users. This feature helps you to notify users through
email about events such as a planned maintenance activity. It is useful when you have a dedicated support
team for managing the RPA operations.

Прим.:  The email channel is disabled by default.

1. Navigate to Administration > Settings > Notification settings.
2. Click Edit to enable or disable the required notification channel.
3. Enable the required notification channel. For more information about notification channels, see

Notification channels.

Прим.:  Notification channels enabled by an administrator are applicable to all the Control Room
users.

4. Specify the email address or email distribution list to whom you want to send the email report.

Прим.:
• You can specify multiple email addresses and email distribution lists separated by comma.
• You can send an email notification to a specific email distribution list.
• You cannot send email notifications to public domain addresses such as gmail.com, yahoo.co.in,

and so on.

5. Щелкните Сохранить изменения.

Enable or disable event categories
As an individual user, you can enable or disable the required events categories to receive notifications, and
control notifications traffic in your Control Room instance.
Ensure that the required event category is enabled by Control Room administrator.

1.
Click the Notifications ( ) icon.

2.
Click the Settings ( ) icon in the Notifications window.

3. Enable the required event category and close the Notifications settings window. For details about
which event category to enable, see Event categories.

Прим.:  The Control Room administrator manages the disabled event categories.
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Enable email report channel
As an individual user, you can use the email report channel to notify Control Room users about various
events through emails.
Ensure that the required email report channel is enabled by Control Room administrator.
Email notifications are sent as an instant notification or email report based on the event severity identified
by the Automation 360 platform. The email report channel is disabled by default.
1.

Click the Notifications ( ) icon.
2.

Click the Settings ( ) icon in the Notifications window.
3. Enable the Email report option to receive email notifications.

An email report, containing the Control Room URL and time duration when the report was generated,
is sent to the specified email addresses or email distribution list.

Прим.:  When you enable the email report channel, consider the following information:
• If the Control Room administrator does not enable the Email report channel, then individual users

cannot enable or disable this option. As a result, individual users cannot be notified through emails.
• If the Control Room administrator disables the Email report channel for a certain duration (for

example, maintenance activity over weekend), individual users cannot receive email reports for
that duration.

• The email report is sent to all email addresses and distribution lists specified by the Control Room
administrator based on the enabled event categories.

• If an event is critical and marked for instant notification, then an email notification is sent
immediately when the event occurs. Otherwise, it is sent as a part of the email report but the email
notification not included in both instant notification and email report.

• A single email report is sent for all бот events.
• An email report is sent twice a day, at a fixed time that is 8 AM (PST) and 4 PM (PST).

Capabilities supporting notifications
With Notifications, you are notified about specific events in Automation 360, such as бот execution tasks
and updates to platform and functionalities.
Automation 360 supports notifications for the following capabilities:

Экспортировать бот

When a бот is exported, you are notified about this automation event. Based on the result (success or
failure) of the export бот functionality available in the platform, you receive a notification that contains the
event details and severity level (Critical, Warning, Info, or Success). This notification is sent only to the
user who exported the бот.

Add or update пакет

When a package is added or a new package version is released in the Control Room, you are notified
about this platform event. This notification is sent to all the Control Room users who have the View
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package permission. Based on your role and package permissions, you can view event notifications. For
package versions information, see View пакет versions available in the Control Room.

Прим.:  For custom packages, a notification is sent only to the corresponding customer and not to all the
Control Room users.

Edit My settings
The My settings page provides user profile specific information.

Мой профиль

Each RPA user is required to have an active profile in the Control Room to built, run and schedule the
deployment of боты as well as for security authorization. Profile information includes user names, email
addresses, passwords, and so on.
To access this information, click the My Settings navigation tab.
The My Settings page displays an expandable My profile tab that shows specific and configurable user
details. Click the Edit icon to update this profile information.
Задачи, связанные с данной
Edit profile settings
Update your user profile settings in the Control Room.

Edit profile settings
Update your user profile settings in the Control Room.
Ensure that you are logged in to the  as the administrator.
Each RPA user is required to have an active profile in the Control Room to built, run and schedule the
deployment of боты as well as for security authorization. Profile information includes user names, email
addresses, passwords, and so on.
1. Navigate to My Settings.

The My Settings page displays the expandable My profile tab for specific and configurable user
details. Click the Edit icon to update this profile information.

2. Update any or all of the general details for your profile.
Опция Описание

Имя Maximum character length is 50.

Фамилия Maximum character length is 50.

Эл. почта для связи Maximum character length is 255.

Изменить пароль 8-15 characters: a-z (lowercase), A-Z
(uppercase), 0-9, and the following special
characters are allowed: @, -, _, !, #, $, %, ., and
&

3. Щелкните Сохранить изменения.
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CoE Manager
Automation Anywhere CoE Manager helps you achieve visibility into your end-to-end automation lifecycle
while accelerating the pipeline generation. It helps scale the automation programs more quickly and
efficiently, while maximizing the value realization from the investment in your automation program.
CoE Manager is available out of the box and requires minimal configurations for first-time use. In addition
to program management capabilities, it provides a consistent and repeatable way of assessing automation
opportunities in order to minimize variations and maximize return on investment (ROI). ROI can be
measured in terms of time and cost saved as well as user-defined KPIs such as operational agility, cash
flow, sustainability, and so on.
CoE Manager is powered by Shibumi platform, a leading provider of enterprise program management
solutions.

Преимущества

CoE Manager helps you in the following ways:
• Scale automation programs more quickly and efficiently.
• Forecast business results, identify metrics for success, and track them through the entire automation

lifecycle.
• Create single view of portfolio status, risks, and interdependencies.
• Informed decision making with timely and accurate data.
• Assess all automation ideas across expected savings, strategy alignment and automation complexity to

enable prioritization.
• Reduce manual effort on multi-level tracking, computing, and reporting.
• Maximize the value (ROI) from your automation investment.
• Boost the value of the pipeline of automation opportunities to build the business case for additional

investment.

Capabilities

CoE Manager is a cloud-based platform which helps manage the automation pipeline and delivery.
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Key capabilities of CoE Manager are:
• Accelerate the automation lifecycle journey with a purpose-built automation CoE management solution

where everyone can share automation ideas.
• Enable the leadership team to make focused decisions by providing dashboards that help maximize the

ROI from the automation program.
• Enable tracking and managing the pipeline by tracking automation program data, set targets, and

tracking the progress. It helps manage the pipeline from idea to delivery to value realization.
• Track automation ROI via native integration with Automation Anywhere.
• Seamless reporting via dashboards and automated report creation.
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• Efficient governance with role-based access control with in-built approval workflows and user
notifications.

Компоненты

The CoE Manager includes the following components:
• Dashboard: Provides graphical insight to help you view the adoption and progress of the automation

program. It displays information on idea velocity, opportunities by stage, forecasted savings versus
program target, value by stage, as well as benefits at various stages.

• Opportunities: Displays all opportunities across idea, pipeline, in-progress, and deployed stages.
• Ideas: Displays new opportunities submitted into CoE Manager.
• Pipeline: Displays approved opportunities.
• In Progress: Displays opportunities currently in design/build stage.
• Deployed: Displays opportunities that are live.
• Risks: Track program risks and their resolutions.
• Reporting: View and export the status of entire automation program or drill-down into each business

unit.
• Admin: Configure program details and targets, questionnaire and weightages, cost estimates, benefit

types, and so on.

Getting started with CoE Manager
CoE Manager provides clear visibility into the backlog of automation ideas, their position in the lifecycle,
and how much value they will deliver back to the business. The following is a high-level overview of how to
get started with CoE Manager:
Add the following email domains to your email client's safe-senders list to ensure users receive the
notifications generated by CoE Manager.
• APP environment (North America) - notifications come from @mail.app.shibumi.com
• EU environment (Europe and India) - notifications come from @mail.eu.shibumi.com
• AP environment (Asia-Pacific) - notifications come from @mail.ap.shibumi.com

Administrator
• Configure your CoE Manager for first-time use: CoE Manager provides program-level administration tabs

to tailor the solution for your use.
Configuration instructions for admin

• Add users: Add participants to specific roles within your CoE Manager.
Add users

• Register and access CoE Manager: You must be invited to use CoE Manager. When you respond to your
first invitation, you will set up a login account. You will use this account for all future use.
Creating and managing your account

• Link Control Room: Link up to three Control Room in your CoE Manager.
Integrate CoE Manager with Control Room

• Customize your CoE Manager: The CoE Manager provides several program-level administration tabs to
tailor it as per your requirement.
Customize the CoE Manager

• Register a digital worker within the CoE Manager: You can review digital worker information from the
Deployed tab and add automations directly on an opportunity. To register a digital worker with an
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opportunity, you can either use the Opportunities tab to search for the opportunity you would like to
update or use the search option (magnifying glass icon) on the Navigation Sidebar.

Once you navigate to the opportunity, you can update the information on the Execution Tracking tab.
This tab is only available for opportunities that are in-progress, deployed, or completed.

To create an automation process, click the blue plus button displayed at the top right of the automation
processes list. Enter the name and automation ID. After creating the process, you can add the cost per
failure.
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Прим.:  The Automation ID is same as Bot ID from Automation Anywhere (see example below).

Once a process is created, the associated KPIs will be displayed in the execution metrics section.
Any user
• Create and manage opportunity: Submit an opportunity, build a business case for it, and track its

progress through the approval stage gates.
Create and manage opportunity

Integrate CoE Manager with Control Room
You can integrate the CoE Manager with the Control Room to monitor your automations and calculate the
savings achieved. You can link up to three Control Room instances with one instance of CoE Manager.
To link a Cloud Control Room to the CoE Manager, follow the steps mentioned below.
1. Create a custom role with the following permissions:

• View everyone's activity
• Создать API-ключ

2. Create a user and assign the custom role created above.
3. Generate API Key for the user.
4. Log in to the CoE Manager by providing your Email Address and Password.
5. Navigate to Admin-Tech tab.
6. Click the placeholder URL in the Automation Anywhere URL column.
7. Click Edit in the Automation Anywhere URL field and enter the Control Room URL.
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8. Enter the username in the Automation Anywhere Username field.
9. Enter the API key in the Automation Anywhere API Key.
10. Щелкните Сохранить.

The Enabled column automatically changes to Yes when you save the URL, username, and API key.

Customize the CoE Manager
The CoE Manager provides several program-level administration tabs to customize it as per your
requirements. You must have an admin role to customize the CoE Manager.

Admin - Program

In the Admin – Program tab, you can configure general settings for the overall program.

Program Details
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Вариант Сведения

Program Start
and End Dates

Displays the start and end
dates for the program.

Currency
Symbol

Displays the currency symbol
alongside savings values.
This setting applies to all
opportunities.

Primary Benefit
Measure

Displays the primary
quantitative measure for the
CoE Manager as either hours
or currency. For example,
if you select currency, the
program dashboard tab
displays forecasted savings
on the top-left corner of the
page. If you select hours,
the program dashboard tab
displays the forecasted hours
saved.

Формат номера Controls how large numbers
are abbreviated. The options
are full number, thousands, and
millions.

Number Suffix Automatically assigned based
on the number format selected,
has a value of K for thousands
and M for millions.

Formatted
Decimal Places

Specifies how many decimal
places to display in numbers
formatted with M or K based on
the number format selection
described above.

Assign Intake
Submitter as
Opp Owner

Determines whether the
system should create an
account for the user submitting
the opportunity. This is
applicable for users who
currently do not have an
account with the CoE Manager.
If set to Yes, the email address
in the opportunity submission
form is used to create the user
account. Ensure the email
domain is whitelisted within the
CoE Manager.

Track Program
Risks

Specifies whether or not to
show the risks tab at the
program level.
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Вариант Сведения

Show Opp
Activities As

Specifies how opportunities
activities are displayed on the
activities tab. You can choose
between a List and a Gantt-
Chart.

Opp Target –
Overall Score
Calculation

Choose whether you want
to use amount or hours to
calculate opportunity targets.

Opp Target –
Amount and
Hours Saved

Specifies the target amount
and hours saved for individual
opportunities. For calculating
the Overall Score for an
opportunity, the percentage
achievement toward these
targets as well as the business
alignment percentage is used.

Weighted Benefit per Stage

Determines the weightings to calculate the
weighted benefits for opportunities at each stage in
CoE Manager. The weighted benefit is calculated by
multiplying the estimated value for each opportunity
with the corresponding factor to reflect the
confidence of the benefit being achieved. Typically,
opportunities in the idea stage are weighted lightly
and gain in weighted value as they progress toward
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deployment. The weighted value is used to estimate
total program savings.

Colors Specifies the hexadecimal color codes to use for
highlights in the system. The alert color is applied
when highlighting severe issues, the warning color
is applied when highlighting developing issues, and
the normal color is applied for normal operations.
The neutral color is applied as a default color in
non-alert situations.

Advanced Views Sets the visibility of the admin tabs. Для получения
дополнительной информации см.
• Admin - Advanced
• Admin - Users
• Admin - Tech | Integrate CoE Manager with Control

Room

Complexity Cost Estimates Specifies the default implementation cost estimate
to be assigned for an opportunity when either a
low, medium, or high complexity assessment is
specified for that opportunity. You can override the
default cost estimate by typing a new value in the
implementation cost field on the details tab for the
opportunity.

Business Unit List and Opportunity Sources Lists the business units and opportunity sources for
the automation program. Use the Create Business
Unit and Create Opportunity Source buttons at the
top of the section tabs respectively to create the
business unit and opportunity sources.

Monthly Targets Lists the program and business unit targets. You
can enter the targets for the program as a whole
and individual business units in this list.

Admin - Users

In the Admin - Users tab, you can manage role assignments on individual opportunities.
Opportunity Role Assignments
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Displays the list of opportunities and their participants along with the role of the participant (owner, admin,
or collaborator) in that opportunity.

Admin - Tech

In the Admin - Tech tab, you can manage the integration of automation platforms for the program.
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You can integrate up to three Cloud Control Room instances with the CoE Manager.

Admin - Advanced

In the Admin - Advanced tab, you can define the detailed prompts for additional benefits, complexity
and strategic alignment questions for automation opportunities. You can also specify the display icons
across the CoE Manager.

Label Settings You can change the labels for workstream,
complexity and strategic alignment attributes in the
details section of an opportunity.

Opportunity - Addl Benefit Types Defines up to five categories of benefits in the
additional benefits section on the details tab for
opportunities. You can track benefit amounts
and comments for each benefit category for the
opportunities.

Opportunity - Complexity Defines up to five complexity questions, weighting
for each question and the scoring scale. You can
rate each opportunity on a scale from none to very
high to drive a complexity score (based on the
weightings) for the opportunity.

Opportunity - Strategic Alignment Defines up to five strategic alignment questions and
the weighting for each question. You can rate each
opportunity on a scale from none to very high to
drive an alignment score (based on the weightings)
for the opportunity.

Icon Preview CoE Manager comes preconfigured with the
preferred icons and color schemes. You can
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customize these using Font Awesome icons to
highlight key measures for individual opportunities
as well as aggregated information. The Browse
Icons button allows you to browse Font Awesome
icons on their website. The Icon Preview entry
loads the specified Font Awesome icon (based on
an icon ID from the Font Awesome website) in the
panel to the right.

Icon Assignment Defines the icons to be displayed throughout CoE
Manager by using Font Awesome icon IDs from the
Font Awesome website.

Export and Import You can bulk import opportunities into a program.
Click the Export button to download the
opportunity template. This is a pre-filled template
with existing opportunities in the CoE Manager. To
add new opportunities, follow the below steps:
1. Open the downloaded template and delete the

existing data.
2. For each row of new opportunity to be created,

enter the data as outlined below:
• Column A: Default to Opportunity_t
• Column B: Do not fill
• Column C: Enter the Business Unit for the

opportunity being created
• Column D to AE: Fill the details as required

3. Save the excel file.
4. Click the Import button.
5. Browse and select the file and click Import.

Configure CoE Manager for Single Sign-On (SSO)
Use the SSO option to enable the CoE Manager authentication through an identity provider (IdP) using
Security Assertion Markup Language (SAML) 2.0 protocol.

SAML SSO login setup

Before configuring the CoE Manager, ensure you have completed the following requirements:
1. Download the Service Provider (SP) metadata for your respective CoE Manager region using the links

provided below:
• US environment: Test | Prod
• EU environment: Test | Prod
• AP environment: Test | Prod
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2. Configure your Identity Provider (IdP) with the metadata obtained from the previous step and in SAML
assertion, provide the following:
• Email, First Name, Last Name, and NameID
• Redirect URL for IdP-initiated login as a relay-state parameter

3. Provide the IdP metadata and the attribute names received from IdP (Email, Last Name, and First
Name) to the Automation Anywhere support team.

Login workflow

SAML SSO login can be configured using one of the following methods:
• Service provider-initiated login: The SP-initiated login starts with the CoE Manager and is triggered

when a user attempts to access the application through a URL. SP-initiated login requires a redirect to
the appropriate IdP to ensure proper authentication before access is granted to the service or to any
specific object. Depending on whether SSO is configured as mandatory or optional, your login workflow
will vary. See below for more information.
• Mandatory SSO: After SSO is enabled, enter your email address in the CoE Manager login page

and click Next.
As the CoE Manager is a multi-tenant application, you must use an email address to determine
the IdP to be redirected to. This email address can be from any domain associated with your
organization. CoE Manager will redirect to the IdP based on the entered email domain. For example,
if your organization is Acme Corp, you might have acme.com and acmeent.com as associated
domains. In this event, any address with @acme.com and @acmeent.com will redirect to the IdP
when you click Next. You will be redirected back to the CoE Manager page after IdP authentication.

• Optional SSO: On the login page, enter the email address and click Next. Instead of being
automatically redirected to the IdP, you will be prompted to either enter a password or select the
option to log in with SSO, which will be sent to your IdP for authentication.

Прим.:
• CoE Manager supports deep linking with SSO. After clicking the link, you should enter your email

address in the CoE Manager login page. You are then redirected to the IdP for authentication. After
authentication, you are redirected to the URL initially requested.

• CoE Manager creates a cookie after successfully logging in to the application using SSO. This
ensures the subsequent logins to CoE Manager will bypass the username and password screen
and redirects to the appropriate SSO login page automatically. You can also override the cookie by
navigating directly to the CoE Manager login page, that is https://<region>.shibumi.com/
shibumi/login.

• A user account is automatically created after successfully logging in to the CoE Manager using SSO
for the first time.

• IdP-initiated login: With IdP-initiated login, you can access the CoE Manager directly through the
IdP (without a login page being displayed). When CoE Manager is launched using this method, you
are taken directly to your organization's CoE Manager home page or to a URL provided by the IdP as a
relay state parameter.
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Account provisioning

CoE Manager provisions user accounts as needed for organizations with enabled SSO. Accounts are
generated when:
• A user is assigned a role on an object in CoE Manager
• A user is invited to a CoE Manager work item
• A user first attempts to access CoE Manager

The typical account provisioning sequence would be for a user to be invited into a work item in CoE
Manager by an existing user. This triggers the auto-provisioning of their account. If this is not done,
when the user attempts to access CoE Manager the first time the account is provisioned, the user will not
have access to any work items. This can be a confusing experience. Therefore, it is a recommended best
practice to ensure that the users are invited to participate in a work item prior to the first access.

Прим.:  User accounts are not imported in bulk from the IdP. Users are not automatically added or
removed from the CoE Manager instance when a person joins or leaves the organization.

When a user is authenticated via an IdP, their first and last name are updated in CoE Manager to reflect
the attribute values supplied in the SAML payload (the mapping of first name and last name to attributes is
part of the SAML configuration in CoE Manager and in IdP).

Using CoE Manager
CoE manager provides a structured and consistent way of assessing all submitted opportunities, thereby
increasing confidence in the quality of automation pipeline.

Work item basics CoE Manager is composed of Opportunities,
Business Units (referred to as workstreams by
Shibumi), and a Program. In CoE Manager, these
are all called work items. They are places to review
and add information. Each of these work items are
made up of tabs and sections.
Work item basics

Roles and user management Users are assigned to specific roles, and the
role determines how the user interacts with CoE
Manager. In CoE Manager, all users have inherited
permissions, which means that the permissions
extend below where they have access.
Roles and user management

Workspace CoE Manager workspace is divided into Navigation
Sidebar, Header, and Work Area.
Workspace overview

Personas and available actions CoE Manager personas represent the people
within your organization who participate in your
automation program. The titles given to these
personas might not match the job titles used within
your organization. Use the goal descriptions to
help you map your organization titles to the CoE
Manager personas. Once you have mapped your
positions to the CoE Manager personas, the topics
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to cover column (in Persona overview link below)
highlights the solution activities most applicable
to the persona. Persona-specific support site
articles are available through the persona column
hyperlinks.
Persona overview

Review automation program status Review up-to-date program data in a single location
to drive decision making.
Reporting

CoE Manager FAQ
For details and questions on the CoE Manager powered by Shibumi platform, review this FAQ.

Обзор

What is CoE Manager? CoE Manager (powered by Shibumi) is a cloud-
based solution to manage the automation pipeline,
delivery, and benefits of the automation program.

Why do I need CoE Manager? CoE Manager helps you take control of your end-to-
end automation lifecycle while accelerating pipeline
generation. It helps CoEs to scale automation
programs more quickly and efficiently driving core
Automation Anywhere deployments and maximize
the value (ROI) from your automation investment.
CoE Manager elevates the value of the pipeline of
automation opportunities to build the business case
for additional investment.

I already have an existing app for managing
my automation pipeline. Do I still need CoE
Manager?

CoE Manager is a purpose-built automation CoE
management solution that provides advanced
capabilities to drive automation success and
comes with a native integration with Automation
Anywhere. It eliminates the manual overhead
required in a homegrown tool and allows CoEs
to focus on accelerating the automation pipeline
instead.

Is CoE Manager a SaaS solution? Yes, CoE Manager is hosted in Shibumi's cloud
infrastructure. Shibumi uses AWS as their cloud
provider. Currently, CoE Manager/Shibumi RPA
accelerator is hosted in the AWS zones in North
America, Germany, and Australia.

Which compliance standards does CoE
Manager support?

Automation Anywhere and Shibumi are committed
to maintaining compliance with key global
information security and regulatory standards,
including:
• Service Organization Control (SOC) 2, Type 2

certification
• CSA Cloud Controls Matrix standards compliance
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• EU Model clauses supported

What data retention policies, if any, are in
place?

Shibumi retains customer information for as long as
the account is active, or for as long as it is needed
to provide a customer or sponsoring organization
with specific requested services.

Do I need Automation Anywhere to use CoE
Manager?

No. CoE Manager can work independent of
Automation Anywhere. However, Actual ROI
information cannot be recorded in COE Manager
unless it is linked with an Automation Anywhere
Control Room.

What is the Opportunity Lifecycle enforced by
CoE Manager? Can it be modified?

All opportunities in CoE Manager follow a tollgate
process comprised of 4 stages given below:
• Stage 1: Idea
• Stage 2: Конвейер
• Stage 3: В процессе выполнения
• Stage 4: Развернутые

These four stages are not configurable by an
administrator or end user. However, they can be
customized by Automation Anywhere for your
implementation of CoE Manager if desired. Contact
your Automation Anywhere representative to
explore this.

Can I use CoE Manager to manage my
automation pipeline outside of Automation
Anywhere?

Да.

Does CoE Manager support single sign-on? Yes, the CoE Manager supports full SAML or SAMLv2
integration into any IDP or SSO solution such as
Okta.

Начать

How do I activate CoE Manager? Contact your Automation Anywhere representative
if your organization has not yet purchased CoE
Manager. Each SKU will represent a unit of one CoE
Manager instance for an unlimited number of users
per year.

How do I access CoE Manager? Depending on the region from where CoE Manager
was purchased, you can access CoE Manager
through one of below links.
• North America
• Europe
• APJ

Прим.:  Your account should already be setup in
CoE Manager before you logging in. For the account
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setup process, refer to Getting started with CoE
Manager.

Is there an integration between CoE Manager
and Automation 360?

Yes, you can link up to three Automation 360
Cloud Control Room to a CoE Manager enterprise
instance. This allows CoE Manager to collect бот
activity data to monitor automation executions and
calculate achieved savings. For an On-Premises
environment, a бот will be provided to push data
from an On-Premises Control Room to the COE
Manager cloud.

Which version of Automation Anywhere is
CoE Manager compatible with?

CoE Manager integrates with Automation 360 Cloud
Control Room out of the box and integrates with
On-Premises environments through a digital worker.
For further details, refer to CoE Manager.

Does CoE Manager require any third-party
software applications?

No.

What are the hardware requirements for CoE
Manager?

CoE Manager is a cloud-based solution accessible
via a browser and does not need any hardware
setup.

Which browsers does the CoE Manager
support?

Google Chrome, Mozilla Firefox, Microsoft Edge, and
Safari.

Can CoE Manager integrate with third-party
reporting tools?

Да. Contact your Automation Anywhere
representative to explore this.

Can CoE Manager integrate with third-party
process/task mining tools?

Да. Contact your Automation Anywhere
representative to explore this.

Does CoE Manager support APIs? Да. CoE Manager/Shibumi exposes create, read,
update, and delete capabilities through its GraphQL
API.

Can I customize dashboards? Да. This feature will be enabled in a future product
release.

Can I export the dashboard and reports? Да. You can export to Excel or CSV wherever
applicable. Export to PDF will be enabled in a future
release.

Can I add new business units to manage my
automation opportunities?

Да. You can create as many business units as
you need. Ability to add sub-business units will be
provided in a future release.

How do I assign opportunity to a user? You can assign the opportunity to a user as given
below:
1. Open the opportunity.
2. Click the Avatar icon on the top right.
3. Enter the email address of the user you want to

add.
4. Select the role and click Add.

I am unable to login into CoE Manager. What
do I do?

Contact your CoE Manager administrator to start a
password reset.
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My organization already uses Shibumi. Can I
use CoE Manager with Shibumi license?

No. A new license needs to be purchased from
Automation Anywhere to use the CoE manager.

Can I do a bulk upload of automation
opportunities?

Да.

Where do I report a problem with CoE
Manager?

For reporting any unexpected or deficient
functionality, submit a support ticket to Automation
Anywhere.

Can the email branding be changed to
customer's requirements?

This feature is not currently available.

Can I rename, copy, move, or delete an
opportunity?

Yes, you can access these options from the three
vertical dots icon on the top right.

Bot Store
You can access Bot Store from the Control Room. From Bot Store, you can download боты or packages to
your Control Room repository.
There are two ways for you to get боты and пакеты from Bot Store into your Control Room:
• You can load items directly from Bot Store to your Control Room, without needing to download the

items locally. Подробнее см. в разделе Directly import боты and пакеты from Bot Store to Control Room.
• You can download items from Bot Store locally, then import them to your Control Room, even if your

Control Room is not connected to the internet. Подробнее см. в разделе Download locally and import
боты and пакеты from Bot Store to Control Room.

Resources:  Подробнее: Automation Anywhere Bot Store Learning Trail (A-People login required).

Понятия, связанные с данным
Бот permissions for a role
Assign бот permissions when creating a role with the View my боты feature permission.

Access Bot Store from the Control Room
As a Bot Store registered user, you can log in to Bot Store from the Control Room.
You must have valid Bot Store credentials to access Bot Store from the Control Room. If you do not have
valid Bot Store credentials, you must register with Bot Store.
1. Войдите в Control Room.
2. Click the Bot Store tab.

Bot Store opens in a separate window (https://botstore.automationanywhere.com).
3. Log in using your Bot Store credentials.

In the Control Room, you can see My downloads under the Bot Store tab.
Watch the following video on how to find боты on Bot Store.

Понятия, связанные с данным
Bot Store
You can access Bot Store from the Control Room. From Bot Store, you can download боты or packages to
your Control Room repository.
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Задачи, связанные с данной
Submit боты or packages to Bot Store
You can submit боты or packages from the Control Room to Bot Store. If your bot includes dependencies,
submit all dependencies. Submit a demo бот that demonstrates the use of the package.
Directly import боты and пакеты from Bot Store to Control Room
You can load items directly from Bot Store to your Control Room without the need to download the items
locally.

Submit боты or packages to Bot Store
You can submit боты or packages from the Control Room to Bot Store. If your bot includes dependencies,
submit all dependencies. Submit a demo бот that demonstrates the use of the package.
You must have a system-created AAE_Bot Store Publisher role in order to submit боты or packages to
Bot Store. См. раздел System roles.
1. Download the A2019 Bot Store Bot template from GitHub: A2019 Bot Store Bot Template.
2. Войдите в Control Room.
3. Log in to Bot Store using the Bot Store credentials.
4. На левой панели щелкните Автоматизация.

Отобразится список доступных  и форм.
5. Click Public workspace and select the Bot Store folder.
6. In the Automation page, move your mouse over the Action toolbar and click Submit to Bot Store.

a) In the Submit to Bot Store page, review the dependencies that will be bundled with your бот
(including a parent бот) and make changes as required. In addition, ensure that the бот and all
dependent боты and files are in the same folder to submit to Bot Store.

b) Click Next to review the Bundled packages to ensure all packages are included with your
submission.

c) If the бот you want to submit and the bundled package look complete, click Submit.
When choosing a name for your bot or package, ensure it is unique and descriptive so it is easily
searchable on Bot Store.
Alternatively, click Back to go back.
When you submit your files, the system displays the following message: <bot/package name>
submission is in progress. Go to Bot Store > My Submissions to complete
your submission form. You will receive a confirmation email when the
submission is completed.

d) Click Take me to Bot Store to complete your submission form in Bot Store.

When you resubmit files to Bot Store, it overwrites the previously submitted files, which are in a
Draft status.
• It can takes three to five business days for review and approval of your bot or package.
• For any questions on bot and package submissions, contact Contact Bot Store Support or select the

Have questions about submitting a bot option on Bot Store pages.

Понятия, связанные с данным
Bot Store
You can access Bot Store from the Control Room. From Bot Store, you can download боты or packages to
your Control Room repository.
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Задачи, связанные с данной
Access Bot Store from the Control Room
As a Bot Store registered user, you can log in to Bot Store from the Control Room.
Directly import боты and пакеты from Bot Store to Control Room
You can load items directly from Bot Store to your Control Room without the need to download the items
locally.

Directly import боты and пакеты from Bot Store to Control Room
You can load items directly from Bot Store to your Control Room without the need to download the items
locally.
You must have a system-created AAE_Bot Developer role in order to download боты or packages to
your Control Room repository. См. раздел System roles.
1. Navigate to Bot Store site.
2. Log in with your A-People credentials to download from Bot Store.
3. Select a бот or пакет.

Once you have selected your бот, you are redirected to a detailed bot page.
4. Click the Get Bot button.

A confirmation window prompts you to confirm the request.
5. Click Ok, Get Bot to confirm the request.

You can choose from the Add to Control Room or Download as a zip file options.
• The Add to Control Room option requires you to specify your Control Room URL.
• The Download as a zip file option requires you to save the бот locally on your device and

confirm the location path for your download to begin.

6. Select the Add to Control Room option to load the bot directly to your Control Room.
7. Enter your Control Room URL.
8. Войдите в Control Room.
9. Navigate to the Automation page.
10. Open your Bot Store tab.
11. Click Add to RPA Workspace in the Action toolbar.

The following message appears: If you have any files already installed in private
workspace, they will be overwritten.

12. Select Yes, continue to overwrite an existing file and continue with the installation, or select No,
cancel to cancel your download.
The installation status of the selected file changes to Installed.

13. Verify the downloaded боты in your Bot Store folder of the private workspace.
The custom packages downloaded from Bot Store are available in the Packages repository. You can
navigate Bot Editor > Action Palette.

14. Verify that the downloaded пакеты have been enabled in the Packages repository. If the пакеты are
not enabled, then go to individual packages and enable them.
Watch the following video on how to download a Bot Store бот to your Control Room.

Понятия, связанные с данным
Bot Store
You can access Bot Store from the Control Room. From Bot Store, you can download боты or packages to
your Control Room repository.
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Задачи, связанные с данной
Access Bot Store from the Control Room
As a Bot Store registered user, you can log in to Bot Store from the Control Room.
Submit боты or packages to Bot Store
You can submit боты or packages from the Control Room to Bot Store. If your bot includes dependencies,
submit all dependencies. Submit a demo бот that demonstrates the use of the package.

Download locally and import боты and пакеты from Bot Store to
Control Room
You can download items from Bot Store locally then import them to your Control Room, even if your
Control Room is not connected to the internet.
You must have a system-created AAE_Bot Developer role in order to download боты or пакеты to your
Control Room repository. См. раздел System roles.
1. Navigate to Bot Store site.
2. Log in with your A-People credentials to download from Bot Store.
3. Select a бот or пакет.

Once you have selected your бот, you are redirected to a detailed бот page.
4. Click the Get Bot button.

A confirmation window prompts you to confirm the request.
5. Click Ok, Get Bot to confirm the request.

You can choose from the Add to Control Room or Download as a zip file options.
• The Add to Control Room option requires you to specify your Control Room URL.
• The Download as a zip file option requires you to save the бот locally on your device and

confirm the location path for your download to begin.

6. Select the Download as a zip file option
You can save the бот locally on your device and when you confirmed the location path, your download
begins.

7. Войдите в Control Room.
8. Navigate to the Automation page.
9. Щелкните Импортировать ботов.
10. Щелкните Обзор.
11. Select your downloaded zip file at the location path you saved.
12. Specify the option to have your бот in the Public or Private tab.
13. Click Import to import the downloaded bot.
14. Navigate to the Public or Private tab that you specified.
15. Open your Bot Store folder.
16. Access the бот.

You can now use the бот from Bot Store to start your automation experience.
To use a Bot Store package, open the бот you want to edit and access пакет from the Действия
panel.

Прим.:  For users who want proxy access to Bot Store, you can reference this knowledge base article
for a workaround.
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Getting started with Частный Bot Store
Use Частный Bot Store to view and submit боты and бот use cases within your company. Use admin tools
to review and publish боты and manage users.
The following is a high-level overview of how to get started with Частный Bot Store:
1. The Частный Bot Store support team creates admin users for your company.
2. Optionally, the support team helps you set up SAML-based SSO or Active Directory Federation Services

(ADFS) integration.
3. Admin users grant other users Частный Bot Store access and permissions. (It is automated if you use

SAML-based SSO or ADFS).
4. Users create бот listings and submit them for approval.
5. Admin users can approve or reject the submitted боты.

• If approved, the бот listing is published and is available on Частный Bot Store for other users
within the organization to view.

• If rejected, the бот author receives feedback on what has to be updated. The бот author updates
the бот and resubmits it.

6. Other employees within the company access the published бот listings and use them in their
automation tasks.

Понятия, связанные с данным
Частный Bot Store
Частный Bot Store is a secure internal бот marketplace for a company to post and share details and
documentation for all internally developed боты. Employees can easily discover internal боты and
commands to reuse in addition to all of the боты from the Automation Anywhere Bot Store vendors.

Set up A-People user access to Частный Bot Store
A-People user access and management is included out-of-the-box with Частный Bot Store. Within
Частный Bot Store, your company admin can manage users. Other users with granted permissions can
access Частный Bot Store with the same credentials they use for public Bot Store and other Automation
Anywhere sites.
• Set up A-People user access

After your first admin users get access to Частный Bot Store, they can add additional users. Any
Частный Bot Store user with admin access can manage users from the Private Bot Store - User
Access Settings page.

• Add new users individually or in bulk
a) Navigate to User Access Settings.
b) Click Add Users.
c) Enter the email addresses for the users you want to add.

Invited users will receive an invitation email with instructions to set up their account.

• Change user permission level
Only admin users can modify permission levels by selecting the correct level in the Access panel.

• Delete users
Select Delete in the Actions panel.
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Задачи, связанные с данной
Submit and approve боты using Частный Bot Store
Use Частный Bot Store to submit, review, and approve detailed бот listings for all of the боты your team
has built.

Set up SAML user access to Частный Bot Store
Use SAML-based single sign-on (SSO) or Active Directory access to ensure that your Частный Bot Store
user access is updated automatically when users join or leave your company. Users can log in to Частный
Bot Store using the same credentials they use for other applications.
• Set up SSO or Active Directory Federation Services (ADFS) user access

The Частный Bot Store support team will help you set up SSO or Active Directory user access.
• Provide details about Частный Bot Store in your identity provider (IdP) settings.
• Provide the Частный Bot Store support team some information about your system.

The Частный Bot Store support team will verify the information and complete the integration.
After the integration is completed, your Частный Bot Store user access will be managed
automatically by your SSO or ADFS user access.

• Change user permission level
Admin users can change a user's permission level by navigating to the Частный Bot Store Settings
page and updating user permissions.
Admins can only modify a user permission level if a user is an active Частный Bot Store user.

Задачи, связанные с данной
Submit and approve боты using Частный Bot Store
Use Частный Bot Store to submit, review, and approve detailed бот listings for all of the боты your team
has built.

Submit and approve боты using Частный Bot Store
Use Частный Bot Store to submit, review, and approve detailed бот listings for all of the боты your team
has built.
• Submit internal боты:

To submit a new бот:
a) From Частный Bot Store, click My Submissions.
b) Click Add New Bot.
c) Enter all the required fields, such as бот description, benefits, and requirements.
d) Review the documentation examples for each field and follow the suggested guidelines.
e) Click Submit or click Save to save the бот before submitting it.

After you submit your бот, your Частный Bot Store admin team receives an email to review the
бот.
Your бот will be published or it might be send back for an update and resubmission.
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• Review internal бот submissions
Частный Bot Store admin users approve or reject бот submissions before they can be published.
a) As an admin user, navigate to Частный Bot Store and click All Submissions.
b) Click Review Bot to review each submitted бот.
c) Approve or reject the submitted бот:

• Approve and publish a bot: On the Review Bot page, click Approve to publish the бот.
• Reject the bot and request updates: On the Review Bot page, click Reject to reject the бот

and send feedback to the бот submitter with instructions for updates.

Submit and manage бот ideas using Частный Bot Store
Use Частный Bot Store to submit, manage, and prioritize бот ideas for your development requirements.
• Submit бот ideas

a) From Частный Bot Store, click Suggest Bot Idea.
b) Fill in all the fields about your бот idea, with as much detail as possible.
c) Щелкните Отправить.

After you submit the бот idea, your admin team will review and prioritize it. The admin team might
contact you for more information about your бот idea.

• Manage бот ideas
Частный Bot Store admin users can manage and prioritize бот ideas.
a) As an admin user, navigate to Частный Bot Store and click Manage Bot Ideas.
b) Click Review to review each submitted бот idea.
c) Edit any of the fields as required.
d) Select a Bot Priority level for the бот idea.
e) Щелкните Сохранить.
f) Click the Mail icon to contact the бот idea submitter to request additional details.

Watch the following video on how to submit a бот idea to Bot Store.

Custom filter management in Частный Bot Store
Create your own filters and tags to organize your automations in Частный Bot Store using the custom filter
management page.
Custom filter management enables you to perform the following activities:
• Rename any of the default filters such as Applications and Departments, and tags (specific

categories) such as Excel and Finance.
• Add up to six of your own custom filters.
• Add your own custom tags, with up to three nested layers of tags, for example, 2021 > Q1 > January.
• Select which filters you want to appear first in your Частный Bot Store navigation.
• Select up to five top tags to appear first under their filter.
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The custom filters are displayed throughout Частный Bot Store, including:
• In the top navigation, filters on the left, and search results.
• On the listing submission form, where бот builders can select custom tags for their боты.
• On бот detail pages, where users can see how each боты is categorized.

Edit filters

1. You must have an admin user permission to access the Manage Filters page in Частный Bot Store.
2. Navigate to Private Bot Store > Manage Filters > Admin Tools > Manage Filters.
3. Edit the default filters to match your company terminology.

Whenever possible, use default filter names, such as Departments, rather than creating your own
filters. As a result, all the existing боты are already tagged and you do not have to tag them again.

4. Under Actions, click the Rename Filter action (pencil icon) to rename the filter.
5. Click Add Filter to add a new filter. Enter the name for the new filter.

You can add up to six custom filters.
6. Select a filter and click Reorder entry on the left and place the filter into your desired order.

The filter order is reflected in the Частный Bot Store navigation and the filter panel.
7. Click the delete (X) action in the right column to delete any custom filter.

You cannot delete default filters.

Edit tags

1. Navigate Admin Tools > Manage Filters > Actions select a filter and click the tree icon Add and
Edit Tags action.

2. Select a tag and click the tree icon to Add Child Tag within a tag. Enter a new child tag name.
You can add up to three layers of nested tags.

3. Click the Rename Tag action to rename any tag.
For the default tags, the original Tag Name continues to appear in the Default Name column for
your reference.

4. Select up to five Top Tag in the left column to display those tags at the top of the list within each
filter.
Use this for your company most-used applications or other important бот categories. Other than the
selected Top Tag, tags are displayed in alphabetical order.

5. Click the delete (X) action to delete any custom tag.
You cannot delete the default tags.
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Оптимизация
Bot Insight is an analytics platform that provides real-time, interactive, and smart insights about business
processes and operational intelligence. Bot Insight is available with out-of-the-box dashboards that you
can start using instantly. These dashboards provide analyzes to measure the performance of your digital
workforce and predict and solve preventable business problems.

Business analytics through Bot Insight
Automation Anywhere Bot Insight processes real-time and interactive insights about business processes,
and provides operational intelligence. Access the боты, and manage and instrument them to gather
business analytics and insights, and publish dashboards.
1. Create and edit bots

The cloud-based бот editor provides tools, packages, and actions to create боты to automate
processes.

2. Instrument the bot for analytics

Business analytics provides information about the transactional analytics for the data that is logged
by the variables that are tagged in a task. The information provided can be about the total sales in a
month, invoicing and payment trends, insight about new customers, and quote-to-order ratio.

3. Access Bot Insight

Access Bot Insight to perform the business analytics.
4. Customize dashboards and widgets

Dashboards represent the RPA infrastructure in the form of meaningful visuals and charts, so that
you can analyze, interpret, and take action on the updates that are important to you. The dashboards
display dynamically updated information of active users, registered clients, failed tasks, apps, bots, bot
schedules, workflows, queues, and the overall status of devices.

5. Publish a business analytics dashboard

Publish a dashboard to display the production data generated by the task. The analytics consumers
who primarily analyze and interpret data can access the published dashboard.

To learn more, search for the Managing RPA Reports Using Automation 360 course in Automation Anywhere
University: RPA Training and Certification (A-People login required).
Понятия, связанные с данным
Информационные панели Bot Insight
Информационные панели Bot Insight имеют специально разработанное графическое представление,
которое упрощает просмотр информации бот.
Задачи, связанные с данной
Run your first бот
Run a бот from the same device that you used to create the бот.
Ссылки, связанные с данной
Analyze пакет
Use the actions in the Analyze пакет to specify the actions and variables to use in the Bot Insight
dashboard and widgets. The Analyze пакет enables you to perform transactional analytics for the data
that is logged by the variables when the бот runs.
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Accessing Bot Insight
This section provides information about how to access Bot Insight.
To use Bot Insight business dashboard, the Control Room must have the Bot Insight license applied, and
you must be logged in as a user with one of the following roles:
1. AAE_Bot Insight Expert

2. AAE_Bot Insight Consumer

3. AAE_Bot Insight Admin

To use Bot Insight external APIs, you must be logged in as a user with AAE_Bot Insight Admin role.

Access Bot Insight from the Control Room
Access Bot Insight to interactively analyze бот data and enhance бот widgets.
Access Bot Insight from the Control Room in one of the following ways:
• From the Control Room, select Dashboard.

a) Locate the Insights tab.
b) In the Insights tab, click Explore Bot Insight.

The Bot Insight window appears.

• На левой панели щелкните Автоматизация. Отобразится список доступных боты и форм.
a) In the Automation page, click PUBLIC to view the public боты that can be viewed, run, and

checked out by other people, based on the permissions set by the administrator.
b) Click PRIVATE to view your боты and files.

Прим.:  Private боты and files cannot be viewed by other users. If a бот or file is checked out
from the PUBLIC tab, it can be viewed and run by other users. However, the боты and files
cannot be edited by other users.

c) Select your бот from the Files and Folders menu.
Alternatively, enter the search parameters in the Search Name field and search for your бот.

d) Open the бот and click Analyze.
The Bot Insight window appears.

Функции для доступа к Bot Insight
Control Room ограничивает доступ к Bot Insight для пользователей с определенными функциями.
Доступ к информационной панели зависит от функций пользователей, назначенных пользователю,
и от разрешения на доступ, предоставленного этим функциям пользователей. См. Управление
доступом на основе функций.
System-generated access is provided to all user types for Bot Insight. Admins can customize the Bot
Insight experience by assigning a user-generated role to users. Каждая функция включает набор
разрешений, предназначенных для специализации функций Bot Insight, которые делают аналитику
более простой или сложной. Admins should evaluate user tasks and functions to assign the role most
appropriate to fulfill user responsibilities, based on the following details.
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Прим.:  Various types of dashboards can be accessed for quick insights. Common types are listed below.
For more details on dashboards, see Информационные панели Bot Insight

• The system-generated dashboard is also known as a Default type.
• The user-generated dashboard is also known as a Custom type.
• The Published dashboard is also known as the Production type.
• When a published dashboard is saved by a user, the dashboard copy is known as a custom

production type.

Apart from Bot Creator, users with the following roles have access to business analytics dashboards:

Администратор Bot Insight Используйте эту функцию для выполнения
указанных ниже операций в Bot Insight.
• Access Bot Insight API
• Analyze the Data Profile of the task data for

which the dashboard report is generated.
• Анализ и сохранение информационных

панелей, созданных системой.
• Анализ, сохранение, публикация и

удаление информационных панелей,
созданных пользователем, и публикуемых
информационных панелей.

• Сохранение в закладках информационных
панелей, их сравнение и предоставление к
ним общего доступа.

Эксперт Bot Insight Используйте эту функцию для выполнения
указанных ниже операций в Bot Insight.
• Анализ данных на информационных панелях,

развернутых в рабочей среде.
• Сохранение созданных системой

информационных панелей.
• Анализ, сохранение, публикация и

удаление информационных панелей,
созданных пользователем, и публикуемых
информационных панелей.

• Сохранение в закладках информационных
панелей, их сравнение и предоставление к
ним общего доступа.

Потребитель Bot Insight Используйте эту функцию для выполнения
указанных ниже операций в Bot Insight.
• Анализ данных на информационных панелях,

развернутых в рабочей среде.
• Сохранение в закладках публикуемых

информационных панелей, их сравнение и
предоставление к ним общего доступа.
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Role-based access control in Bot Insight
Role-based access control (RBAC) enables a Control Room administrator to restrict access to the various
components of Bot Insight.
The Control Room administrator can grant access to various user roles based on your requirements. When
adding a user, you assign appropriate roles to that user. A user will have access to the components and
folders based on the roles assigned to them.

Requirements

Before you publish the dashboard, ensure that the following requirements are met:
• The бот resides in the Public workspace for which you want to publish the dashboard.
• You have the View my bots and Check in permissions to the folder that contains the corresponding

tasks. You need these permissions to move your боты from Private workspace to Public workspace.

RBAC for business analytics

Dashboards for business analytics are available for the tasks that are enabled for analytics. The Control
Room administrator and users who have access to a task can view the dashboards for those tasks. You can
access the dashboard for a task from the Insight tab in the DASHBOARD section of the Control Room
and from the ANALYZE tab in the Workbench.
To view the Bot Insight dashboards, you must be granted access to the folder containing the
corresponding tasks.
For example, you have created various tasks related to sales and accounting and stored them in the Sales
and Accounts folder. If you want to grant access to the sales-related tasks to members of your sales
department, you need to provide them access to the Sales folder. The same applies to grant access to the
accounts-related tasks in the Accounts folder.
The following table illustrates the access the various members of the Sales and Accounts team will have:

Sales_Dep Accounts_Team

Джон Mark Dave Smith Micheal

Access to
the Sales
folder

Да Да Да Нет Нет

Sales1 Да Да Да Нет Нет

Sales2 Да Да Да Нет Нет

Access
to the
Accounts
folder

Нет Нет Нет Да Да

Accounts1 Нет Нет Нет Да Да

Accounts2 Нет Нет Нет Да Да

Accounts3 Нет Нет Нет Да Да
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Информационные панели Bot Insight
Информационные панели Bot Insight имеют специально разработанное графическое представление,
которое упрощает просмотр информации бот.
Информационные панели отображают значимые визуальные элементы и диаграммы, чтобы вы
могли анализировать и интерпретировать данные, а также выполнять важные для вас обновления.
Вы можете использовать динамически обновляемую информацию об активных пользователях, сбоях
задач, приложениях, боты, расписаниях бот, потоках операций, очередях и общем статусе устройств
для создания пользовательских информационных панелей и виджетов.

Прим.:  Для создания информационной панели при выполнении анализа необходимо использовать
пакет анализа версии 2.3.0-20210922-121532 или более поздней. Эта версия пакет доступна начиная
с Automation 360 v.23.

Выполните следующие действия, чтобы применить пакет.
1. В Control Room выберите Управлять > Пакеты > Анализировать.

2. Измените версию пакет анализа на 2.3.0-20210922-121532 или более позднюю.
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3. Сохраните изменения.
4. Запустите бот и убедитесь, что изменения для создания информационной панели применены.

Прим.:  Для применения изменений в общей рабочей области загрузите бот перед запуском
анализа.

Когда вы создаете и запускаете бот, Bot Insight автоматически создает информационную панель
по умолчанию в коллекции: Мои информационные панели. Если у вас есть родительский бот и
дочерний бот, Bot Insight создает отдельную информационную панель для каждого из боты.

Прим.:  The system does not automatically refresh (auto-refresh) the Bot Insight dashboards unless the
user loads a screen or clicks the Refresh button, thereby manually refreshing data on a page.

Когда вы развертываете и запускаете бот на устройстве Bot Runner, Bot Insight собирает всю
информацию, связанную с этим бот. Опубликованная информационная панель этого бот отображает
агрегированную информацию бот.

Прим.:  Some data might not populate in a widget if боты were created in Automation 360 v.12 or earlier
versions. See the following article for troubleshooting: Bot Insight dashboard not populating data in specific
widgets (A-People login required).

В разделе «Мои информационные панели» отображаются следующие панели.
• Operations dashboard
• Business dashboard

Прим.:
• Для просмотра опубликованной информационной панели необходимо обладать функцией

AAE_Bot Insight Admin или AAE_Bot Insight Consumer.
• The data visible on the dashboards is in the UTC time zone.

Viewing Bot Insight dashboards
The Bot Insight dashboards provide customizable widgets for you to gain insights in specific scenarios. You
can view information about your боты on the Bot Insight dashboards from the Control Room.
When you tag variables for analytics in a task and then run the task, Bot Insight generates the analytics
dashboard. By default, the system-generated dashboard has the same name as that of the task. You can
customize this dashboard to your requirements.
Business analytics provide information on the transactional analytics for data that is logged by the
variable tagged in a task. The information provided can be about total sales in a month, invoice, payment
trends, new customer insights, or quote-to-order ratio. You can select your dashboard from the Select a
Dashboard drop-down menu to view the analytics.
Bot Insight provides the following dashboards:
• Configure

The system-generated dashboards are available in the Configure tab in the Bot Insight window.
• Analyze

The customized dashboards can be published and are available in the Analyze tab in the Bot Insight
window.
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• Operation
The Operation dashboard provides information about боты that are created, deployed, or scheduled
to run across different Bot Runner machines. You can use the information to enhance productivity and
take measures based on real-time information for RPA deployments.

1. Log in to the Control Room with one of the following roles:
• AAE_Bot Insight Admin
• AAE_Bot Insight Expert
• AAE_Bot Insight Consumer

2. Click Explore Bot Insight from the Insights tab.
The Bot Insight dashboard appears in a new window.

Viewing Insights
You can view information about business data in Bot Insight.
Click Insights from the Analyze tab to view information about interesting facts on business data.
The Insight dashboard provides information about business data that is logged through Bot Insight without
the need to analyze the dashboards. It provides a snapshot of data that you can use to enhance your бот
productivity. This feature highlights important facts that are inferred from within the business process data
logged by the боты.
A бот created to process orders displays the following information:
• Total processing cost
• Process time
• Monthly payment
• Total payment

The dashboard provides information about the difference between the calculated metric values for a
specific time interval:
• Yesterday
• Последние 7 дней
• Последние 30 дней

The Insight dashboard enables you to configure the variance thresholds for indicating metric-level health.
Perform the following steps to configure the variance thresholds:
1. Click Settings.
2. In the Variance Threshold window, move the slider to the left or the right to adjust the variance

threshold.
• Move the slider to the left for a Poor metric health level.

The poor metric level health is represented in red.
• Move the slider to the right for a Good metric health level.

The good metric level health is represented in green.

3. Enter the values in the Fair field to set the Fair metric health level.
4. Select the Switch poor and good check box to switch between the Poor and Good metric health

levels.
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5. Щелкните Сохранить.

Operations dashboard
The Bot Insight Operations dashboard provides information about боты that are deployed on different
Bot Runner machines and bot statistics based on performance. You can use this information to enhance
productivity and take measures based on real-time information for RPA deployments.
The Operations dashboard provides visual insight into various operational aspects of боты and displays
hyperlinks to the following dashboards:
• Bots Dashboard
• Audit Dashboard
• Device dashboard

Прим.:  Ensure that you have the AAE_Admin role to view all боты information in the operations
dashboards.

These dashboards appear as the Default dashboards and are automatically created by Bot Insight
based on the variables that are used in the бот. You can use the Save As function to save the Default
dashboard as a Custom dashboard. You can also add widgets from the Visualizations menu to your custom
dashboards.
Using widgets

Bots Dashboard

You can view information about the боты that are created, deployed, scheduled, and running across
various Bot Runner machines.
The dashboard displays the following бот information:
• Total Bot Runs: Displays the total number of times the checked-in боты executed from the Bot

Runner machines. (The number displays the total number of боты that have run successfully and failed
to run).

• Total Completed (Success): Displays the number of боты that have ran successfully.
• Total In Progress: Displays the number of in-progress боты.
• Total Failed: Displays the number of боты that had failed to deploy or run.
• Weekly Bot Status: Displays the weekly status of боты that are scheduled to run.

Совет:  You can hover over the widget to view the number of боты that have run successfully, failed to
deploy, and failed to run. It also displays the weekly боты statistics percentage.

• Failure Reasons: Displays reasoning information on боты that had failed.

Прим.:  The Error Message field displays a snapshot of the original error message and extensive
details on why the бот failed. You can export the error messages and logs to a CSV file, which you can
later use to troubleshoot.

Additionally, the Боты dashboard displays the Бот duration (such as minimum, maximum, average, and
summation) of each бот. You can create your own dashboard, add any widget, and calculate the minimum,
maximum, average, and summation of бот run time.
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Audit Dashboard

This dashboard displays various widgets that provide information about Control Room events. Users with
the View everyone's audit log actions permission have access to view the audit information
captured in the Control Room.
System roles.
The dashboard displays the following information:
• Event Distribution by Activity Type
• Event Distribution by User Name
• Event Distribution by Source
• Event Distribution by Control Room Source
• Event Distribution by Workbench Source

You can perform the following actions in the Operations dashboard:
• Enter the name of the dashboard in the Search text box to access a dashboard.
• Click the Favorite tab to bookmark your dashboard.
• Double-click the Favorite menu to remove bookmarks.

You can view information in the following tabs:
• Total Views: Displays the number of users who viewed a particular dashboard.
• Last Refreshed: Displays the time and date of when a particular dashboard was last refreshed.

You can click the arrow next to the Operations dashboard tabs to organize the dashboards to your
requirements.
You can customize the widgets in the Operations dashboard. You can perform the following functions:
• Working with Bot Insight dashboards
• Comparing dashboards
• Sharing a dashboard
• Taking a screenshot of a dashboard
• Downloading a PDF file from a dashboard

Device Dashboard

The Device dashboard displays various widgets that provide information about resource utilization of the
machines on which боты are executed.
The dashboard provides key metrics to analyze the status and utilization of devices. It also displays the
activity history of the боты that are deployed on the machines.
The dashboard displays the following information:
• Online Devices: Displays the number of Bot Runner machines that are active or online at a point in

time.
• Offline Devices: Displays the number of Bot Runner machines that are inactive or offline at a point in

time. Devices can be online even though no боты are deployed on them.
• Bot Schedules on Devices: Displays the number of боты that are scheduled to run on all the Bot

Runner machines.
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• Device Utilization%: Provides the overall time used by боты that are executed across all the Bot
Runner machines. You can view and analyze the utilization information by date using the following
criteria:
• Бот duration
• Unit: %
• Group 1: Start date time of a бот (interval: day)
• Group 2: device name

There is no limit on the number of devices that can be displayed on the dashboard.
• Device Activity History: Provides information about the execution history of боты deployed on each

Bot Runner machine. The Device Activity History table provides the following information:
• Имя устройства
• Имя Бот
• Бот duration (milliseconds)
• Start date time of a бот
• End date time of a бот
• Статус

When the Group1 and Group 2 fields have date type variables and you select Bot Duration as a
metric, the Percentage (%) option appears as an additional option for Bot Duration Unit. Based on
the selected group interval, the percentage is calculated for the бот duration.
Пример. When you select the parameters in the following fields as:
• Group By or Sub By: Date
• Interval: Year
• Metric: Бот Duration
• Бот Duration Unit: Percentage (%)
• The percentage calculated for бот duration is:

(10000/1000ms * 60s * 60m * 24h * 365days) * 100 = %

Прим.:  The percentage calculation of the бот duration is available in all the widgets, except datatable
and maps.

• Top Error Messages: Provides information about the error messages for any бот failure and the
frequency of occurrence.

Business dashboard
The Bot Insight Business dashboard provides information about the Bot Insight data and statistics based
on бот performance. You can use this information to enhance your productivity and take measures based
on real-time information for RPA deployments.
The Business dashboard provides visual insight into the various business aspects of the боты. From this
dashboard, you can access both the Default and Custom dashboards.
Bot Insight automatically creates the Default dashboard based on the variables that are used in the бот.
You can use the Save As function to save the Default dashboard as a Custom dashboard. You can also
add widgets from the Visualizations menu to your custom dashboards.
Using widgets

In the Custom dashboard, Bot Insight enables you to export data from a dashboard widget to CSV files.
Exporting data from a dashboard widget
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You can perform the following actions in the Business dashboard:
• Enter the name of the dashboard in the Search text box to access a dashboard.
• Click the Favorite tab to bookmark your dashboard.
• Double-click the Favorite menu to remove bookmarks.

The dashboard displays the following бот information:
• Bot Name: Displays the name of боты that are associated with the business dashboards.
• Total Views: Displays the number of users who viewed a dashboard.
• Last Refreshed: Displays the time and date on which a particular dashboard was last refreshed.
• Modified By: Displays the name of the user who had last modified the dashboard.

You can click the arrow next to the Business dashboard tabs to organize the dashboards to your
requirements.
In the Dashboard Name tab, select the dashboard that you want to access to view the dashboard. You
can also enter the name of the dashboard in the Search text box to access the dashboard directly.
Click Rank in the Distinct Count row to view the rank of each variable. You can view the string data type
values that are logged by a variable for the maximum or minimum number of times. This further enhances
your ability to verify that the data is logged correctly in the бот.
Viewing ranks of string datatype values

The Business dashboard widgets displays the following information:
• The total number of variables
• The comparison between number variables and transaction status
• The comparison between number variable distribution and transaction status
• A bar chart representing the distribution between the number variables and string variables
• A pie chart representing the relationship between variables in numbers and strings

The Profile dashboard displays бот variables and the transaction data. The Task Name table displays the
variable name, display name, data type, inclusion details, maximum, minimum, average, sum, distinct
count for the date, string, and number variables.
The Transaction Data table displays the variable name, display name, data type, inclusion details,
minimum, maximum, average, sum, and distinct count metrics for the following parameters:
• Machine Name
• Transaction Name
• Transaction Start Time
• Transaction End Time
• Total Transaction Duration (Start Time - End Time)
• Transaction Status (In Progress or Completed)
• User Name (User who runs the бот)

You can use the Preview Data option to view the total number of records maintained for each variable.
When you create and run a бот with multiple Transaction Blocks with Analyze, Open, or Close
commands, all the tagged business variables are displayed in the Transaction Names menu.
You can customize the widgets in the Business dashboard. You can perform the following functions:
• Working with Bot Insight dashboards
• Comparing dashboards
• Sharing a dashboard
• Taking a screenshot of a dashboard
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• Downloading a PDF file from a dashboard

Document Workspace dashboard
The Document Workspace dashboards provide visualizations of learning instance performance and quality
metrics as well as validation operations metrics.
Users with access to Document Automation can view and customize the Document Workspace dashboard
without additional permissions.
The Document Workspace dashboard contains eight widgets, which contain visualizations of learning
instance data. The widgets are customizable:
• You can reposition a widget by dragging and dropping it into a new location.
• You can apply filters, such as by specific learning instance or time frame. Adding a dashboard filter
• You can click a data point in a widget to "drill down" or filter the metrics in that widget. See the

following video:

Document Workspace widgets

Widget Описание

Accuracy % by field A horizontal stacked bar chart that shows the
straight-through processing percentage for each
field in the learning instances

Extraction time per documents A horizontal stacked bar chart that shows the
average extraction time per learning instance in
milliseconds

Number of uploaded documents A line chart that tracks the total number of files
uploaded each day

Number of uploaded pages A line chart that tracks the total number of pages
uploaded each day

STP% by learning instance A horizontal bar chart that shows the straight-
through processing percentage for each learning
instance

STP% over time A line chart that tracks the straight-through
processing percentage for all the leaning
instances by day

Validator performance by weighted average
validation time

A horizontal bar chart that shows the weighted
average time each Validator user spent
performing manual validation per document.

Validator performance by # of documents
validated

A horizontal stacked bar chart that shows the
number of documents each Validator user
validated per day

Dashboard filters

You can use the following dashboard filters to customize the metrics included in the dashboard:
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• Learning Instance Name

Прим.:  By default, both public and private learning instances are included in the dashboard.

• Тип документа
• Page Count
• Дата и время создания

Прим.:  When you set a filter, it is applied to the entire dashboard. To apply a filter to a specific widget,
open the Widgets menu and select which widgets to apply the filter:

Задачи, связанные с данной
Sharing a dashboard
You can share the link to view a dashboard through email using the Share via email option.
Downloading a PDF file from a dashboard
You can download the data available in the dashboard as a PDF file.
Taking a screenshot of a dashboard
You can take a screenshot of the data available in the dashboard.

AARI dashboard
Use the AARI dashboard in Bot Insight to view various widgets that provide information about requests
created from published processes in Automation Anywhere Robotic Interface (AARI).

Обзор

The dashboard provides statistics and shows information about created requests for each process, which
can vary from a simple summary to a complex cross-departmental view. You can use this real-time
information to make process-related operational decisions. For example, consider a scenario where a
manager can get a high-level activity overview of completed and pending tasks in the payroll process,
which can then help the manager take necessary actions about the process.
From the AARI dashboard, you can access both the Default and Custom dashboards. Bot Insight
automatically creates the Default dashboard from the variables used in the process. You can use save the
Default dashboard as a Custom dashboard if required. You can also add widgets from the visualizations
menu to your custom dashboards.
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Based on RBAC, the following users have access to view the data on the dashboard:
• AAE_Robotic_Interface_Admin can view all data inside AARI on the web interface across all teams.
• AAE_Robotic_Interface_Manager can view all data inside AARI on the web interface for their own

teams.

What you can view in AARI dashboard

The dashboard helps you to visualize and track the number of requests that are open, completed,
canceled, or failed.
The dashboard also provides the following capabilities:
• Heat map chart: Visualize data about the percentage of request created for each process for a day.

You can specify the dates by function (day) to get specific information using the following criteria:
• Group1: created date (interval: day)
• Group 2: process name
• Metric: request created in percentage (%) for each process

• Request activity history: This table provides the execution history of the processes deployed on
each Bot Runner machine. It includes information such as the following:
• Имя процесса
• Имя пользователя
• Request details such as the status, ID, end time and start time, duration
• Total human and бот duration
• Total human and бот tasks

• Stacked bar chart: Analyze the average duration taken by each process for human and бот tasks. For
example, consider that there are two processes named API Test-Form 1 and API Test-Form 2 in the бот
task type. For each process, the chart shows the average time (in seconds) taken for its execution. You
can view and analyze this information using the following criteria:
• Group 1: task type (human and бот)
• Group 2: process name
• Metric: duration (average)

Editing a data profile
You can modify the data profile of both the Default and Custom Business dashboards without modifying
the боты.
You can edit the data profile and regenerate the dashboard based on the new data profile. You can edit
the display name of a variable, change its data type, and exclude it from the dashboard.
Bot Insight provides smart data profiling for information about countries, states, and zip or postal codes.
Bot Insight analyzes the information provided in the variables and automatically identifies the information
as:
• Country (country code or country name)
• State (state code or state name)
• Zip code (five-digit zip code)

You can edit the data profile to convert the above parameters from numeric format to string format
(country and state) based on your requirements. You can convert the zip code to either string or numeric
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format, and use the information to create widgets (world and US map widgets) in the Bot Insight
dashboard.
1. Open the Bot Insight dashboard.
2. Click Profile.

The Profile window appears, displaying all the variables that you have tagged during the бот
creation.

3. Щелкните EDIT.
4. Specify a new name for a variable in the Display Name field.
5. Select an option from the Datatype drop-down list to specify a new data type for a variable.

You can change the datatype of a numeric variable to string, string to country, state, and zip code.

Прим.:  Changes to the Data Type parameter cannot be reverted.

6. Clear the Inclusion check box to exclude the variable from the dashboard. Select Inclusion to
include a variable from the dashboard and configure how the initial SMART dashboard is generated.
You can view the minimum, maximum, average, sum, and last value for the numeric values, but not
for the string and timestamp variable types.

7. Click Save and Generate Dashboard to save the changes and generate the dashboard with the
updated value.

Bot Insight dashboard filter
The Bot Insight dashboard filter enables you to apply filters across your dashboards to display the filtered
data. You can save and publish the custom dashboards with preset filters.
Filters in the Bot Insight dashboard enables you to choose different views of the data. You can apply and
save filters in a dashboard to preserve the filtered view. The filtered view displays the same view the next
time you view the dashboard.
Dashboard filters enables different combinations of data in a single dashboard. The filter eliminates the
need for separate dashboards for different users. A single-filtered dashboard allows you to serve data
requirements for a wide range of users.
You can access the dashboard filter from both the Operations and Business dashboards. You can click
each item in the filter list to view the parameters. You can search for a specific parameter in the Search
Automation Name field in the All tab. You can select parameters based on whether to include or exclude
them in the filter. The selected parameters appear in the Selected tab.
When you apply a specific filter, the visual indicator in the dashboard displays the name of the applied
active filter. You can delete a dashboard filter by clicking the delete icon. When you publish a custom
dashboard with the applied the dashboard-level filters, the published dashboard contains the same filters.
You can click Widgets in the widget window to apply dashboard widgets.
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The Bot Insight dashboard provides the following filters:
• Attributes: This filter enables you to include or exclude specific parameters of a given attribute. This

can be the бот name, device name, or user name.
For example, you can use the parameters:
• Model Version to differentiate the payload and to determine if an upgrade is required in the

dashboard. You can also use it as a filter so that the dashboard works correctly even with different
job execution pay loads.

• Job type to identify the type of task such as TASK(Бот Run), WORKFLOW, WORKORDER,
WLM_TASK

• Automation Name to provide a name when running or scheduling the бот
• Object Name to identify the name of the entity for which the audit action is recorded. For example,

to identify the username when the user is edited or created or the бот name when the бот is edited
or created.

• Numeric: This filter enables you to select a specific duration for which you can get the numerical
statistics of the бот. For example, this can be the totalLines that is processed by the бот, or the
duration during which the бот was active.

• Time: This filter enables you to select a single date, or a range of dates to analyze the variables that
are categorized under time and date. This can be the бот start time or end time.

Понятия, связанные с данным
Operations dashboard
The Bot Insight Operations dashboard provides information about боты that are deployed on different
Bot Runner machines and bot statistics based on performance. You can use this information to enhance
productivity and take measures based on real-time information for RPA deployments.

Adding a dashboard filter
To create a dashboard filter, select a field containg the information type you want to filter and define the
return of the data. The filtered view is preserved so that the same view is displayed the next time you view
the dashboard.
1. Open the dashboard to which you want to add a filter.
2. Select the parameter based on your requirements in the Attributes tab, .

The parameter window appears.
a) Enter the name of the variable in the Search field.

The variable appears in the All tab. Select the variable that you want to add in the filter. The
selected variable appears in the Selected tab.

b) Choose one of the following options:
• Click Include to include the variable in the dashboard filter.
• Click Exclude to exclude the variable in the dashboard filter.

c) Щелкните Применить.

The Attributes filter is added to the dashboard.
3. Select the parameter in the Numeric tab.
4. Perform these steps in the selected parameter window:

a) Select the condition that you want to specify in the filter.
b) Enter the minimum and the maximum values.
c) Щелкните Применить.
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The Numeric filter is added to the dashboard.
5. Select the parameter based on your requirement in the Time tab.
6. Perform these steps in the selected parameter window:

a) Select a specific date, or a range of dates.
b) Щелкните Применить.

The Time filter is added to the dashboard.

Ссылки, связанные с данной
Customizing a dashboard
Log in to Bot Insight with the AAE_Bot Insight Expert role to customize the information displayed in
the system-generated dashboard to make it more relevant for an analytics consumer.

Working with Bot Insight dashboards
You can save or delete a Bot Insight dashboard when required. You can also delete a user-created
dashboard.
When you delete a dashboard, it does not impact the data associated with that dashboard. You can
delete dashboards that are available in the Analyze and Configure tabs of the Bot Insight window.
The dashboards available in the Analyze tab are the published dashboards. Therefore, if you delete a
dashboard from the Analyze tab, it will no longer be available for other users.
• Save a dashboard:

a) Open the dashboard that you want to save.
b) From the Actions menu, select Save as.

The Save Dashboard window appears.
c) In the Dashboard Name field, enter the name for the dashboard.
d) In the Dashboard Description field, enter the description of the dashboard.
e) Щелкните Сохранить.

Click Save As to save a default dashboard as a customized dashboard.

• Open the dashboard you want to delete.
a) Click Delete on the toolbar.
b) Click Okay.

Comparing dashboards
You can compare dashboards that belong to two separate processes, or the same process with different
filters. The dashboards selected for comparison appears as a side-by-side view to enable you to obtain
better insights.
• Compare dashboards:

a) Open the dashboard that you want to compare.
b) Navigate to Actions > Compare in the Bots Dashboard.

Your dashboard is now in compare mode. The dashboard you have opened appears in both the
Left View and Right View. You can apply widget filters to your dashboard at any time.
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• Apply widgets to your dashboards:
a) Click the Filter option from your dashboards, represented by the three dots in the corner.

The Filter window now appears and shows the available widgets.

Прим.:  The Filter option next to the Close option accesses the same Filter window. You can
also expand or minimize the Filter window.

b) Select the Left View or Right View.
c) Select the Attributes, Numeric, or Time widgets that you want to apply.
d) Необязательно: Click Clear All to reset all your widget selections.
e) Click Apply to confirm.

You can now compare your dashboard with widgets.

Customizing a dashboard
Log in to Bot Insight with the AAE_Bot Insight Expert role to customize the information displayed in
the system-generated dashboard to make it more relevant for an analytics consumer.
To make changes in a Bot Insight dashboard, create a copy of the dashboard, and then update the copy.
After you create customized dashboards for a бот, you can make changes to the tagged variables. You
can delete and add variables based on your requirements. By default, the standard dashboard always
displays the latest data profile. We recommend you use the system-generated standard dashboard, and
then create customized dashboards from it. Data profile updates are highlighted with a red dot in the
following scenarios:
• When there are data profile updates.

• The variables that are newly added display the message NEW.
• The variables that are deleted display the message DELETED.

• When the customized dashboard data profile does not match that of the standard dashboard.

Задачи, связанные с данной
Editing a data profile
You can modify the data profile of both the Default and Custom Business dashboards without modifying
the боты.

Viewing ranks of string datatype values
Among string datatype values, you can view the ranking based on the maximum and minimum number of
times each string datatype value has been used, as logged by a variable. With this information, you can
better verify whether the data logged in the бот is correct.
1. Open the dashboard for which you want to edit the data profile.
2. Click the Profile tab.
3. Click Rank within the Distinct Count column.

The Distinct Count column displays the number of unique values logged by a variable.

Прим.:  The Rank option is only available for the variables that log values of string datatype. A
message appears displaying the top five values that are logged for the maximum number of times in
the variable.
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4. Select Bottom from the list to display the five values that are logged the least number of times in the
variable.

5. Select an option from the list to display five or ten values in the message box.

Previewing data
You can view all the variable data associated with a task using the Preview Data option.
1. Open the dashboard for which you want to preview the data.
2. Click the Data Profile tab.
3. Click the Preview data option.

A new window appears displaying all the variable data associated with that task.

Verifying data populated in a custom dashboard
After you create a custom dashboard that contains new widgets or customized widgets from the system-
generated dashboards, you can verify the data that is populated in the dashboard.
1. Open the task for which you want to verify the data in Bot Insight.
2. Click Run on the toolbar.
3. Click the ANALYZE tab.

The system-generated dashboard for the task appears.
4. Click the Analyze tab in the Bot Insight window and search for the customized dashboard for which

you want to verify the data.
5. Select the dashboard from the search results.

The dashboard appears.
6. Click the Data Profile tab and verify the data for the dashboard.

Publishing a business analytics dashboard
Bot Insight enables you to publish a business analytics dashboard that is generated for a task. You can
publish both the Custom and Default Business dashboards.
Before you publish a dashboard, ensure that the particular бот resides in the Public folder in the Control
Room.
1. Open the dashboard that you want to publish.
2. Customize the dashboard based on your requirements and verify the content and presentation

formats.
3. Click Publish on the toolbar.
4. Specify a name for the dashboard, and then click Okay.

The dashboard is now published and available to display the production data generated by the task.
The dashboard updates the data each time a task runs in the production environment from the Control
Room on a regular basis.
In the Control Room, ensure that you deploy the бот in the Bot Runner device so that the published
dashboards are populated with data.

Задачи, связанные с данной
Импорт боты
Вы можете импортировать боты с их зависимостями из одного экземпляра Control Room в другой.
Исходным окружением может быть Automation 360 Control Room, Enterprise 11, or Enterprise
10Экземпляр Control Room.
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Save a published dashboard
You can publish a Bot Insight business analytics dashboard that is generated for a task. You can also save
a copy of the published dashboard when required.
Ensure you have the AAE_Bot Insight Admin or AAE_Bot Insight Expert roles assigned to you.
1. Open the Bot Insight Window.
2. Click the Business tab and search for the dashboard for which you want to save a copy of custom

production dashboard.
3. Select the dashboard from the search results.

The selected dashboard appears
4. Select the SaveAs from the Action menu to save the default Production dashboard as a Custom

Production dashboard.
5. In the Save Dashboard window, specify a name for the dashboard and click Okay.

You can add widgets from the Visualizations menu to your custom production dashboard.
You can add, delete, change visualization, apply filters, and so on to customize the dashboard.

Delete a published dashboard
You can publish a Bot Insight business analytics dashboard that is generated for a task. You can also
delete a published dashboard when it is not longer required.
Ensure you have the AAE_Bot Insight Admin or AAE_Bot Insight Expert roles assigned to you.
You cannot delete a default Production dashboard if child (custom production dashboards) are associated
with it. You must first delete the custom production dashboard and then delete the default Production
dashboard. However, you can delete a Custom Production dashboard.
1. Open the Bot Insight Window
2. Click the Business tab and search for the dashboard you want to delete.
3. Click Delete from the Action menu.
4. Click Okay to confirm the deletion.

Reviewing data in a published dashboard
You can review the data available in a published dashboard.
1. Open the Bot Insight window.
2. Search for the dashboard for which you want to view the data.
3. Select the dashboard from the search results.

The selected dashboard appears.
4. Review the data available in the dashboard.

The dashboard reflects the data processed by the task in the production environment.
5. Export the entire dashboard in PDF or PNG format for offline consumption and review.

Sharing a dashboard
You can share the link to view a dashboard through email using the Share via email option.
1. Open the dashboard that you want to share.
2. Click Share via email on the toolbar.

The email client configured on your system appears. The email client contains a link to access the
dashboard.

3. Specify the email address of the recipients and send the email.

© 2023 Automation Anywhere. All rights reserved.     2987



    Automation Anywhere - Оптимизация

Downloading a PDF file from a dashboard
You can download the data available in the dashboard as a PDF file.
1. Open the Bot Insight window.
2. Search for the specific dashboard.
3. Select the dashboard from the search results.

The selected dashboard appears.
4. Review the data available in the dashboard.
5. In the Actions menu, click Download PDF.
6. In the Download PDF window, navigate to the location on your local disk drive.
7. Щелкните Сохранить.

Прим.:  Due to a limitation within the third-party recharts library, you might observe labels
overlapping issue with data in downloaded PDF.

Taking a screenshot of a dashboard
You can take a screenshot of the data available in the dashboard.
1. Open the Bot Insight window.
2. Search for the dashboard for which you want to view the data.
3. Select the dashboard from the search results.

The selected dashboard appears.
4. Review the data available in the dashboard.
5. In the Actions menu, click Screenshot.
6. In the Download PDF window, navigate to your local disk drive location.
7. Щелкните Сохранить.

Использование Bot Insight
Use Automation Anywhere Bot Insight to track бот data for analytics.
Automation Anywhere боты are built, run, and monitored in the Control Room. Bot Insight accesses real-
time business insights and digital workforce performance data to leverage content-level productivity data
from the bots that are deployed. Data is logged for business analytics who has Attended and Unattended
Bot Runner license .
Log in to Automation Anywhere Control Room as an AAE_Bot Insight Expert or AAE_Bot Insight
 Consumer to interactively analyze бот data and enhance бот widgets.
In the Control Room, select the Bot Insight tab, to do the following tasks:
• Interactively analyze the бот data in the dashboards.
• Refine and enhance widgets in the Bot Insight dashboards before they are published for wider

consumption and deployed to production.
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Business analytics
Business analytics provide information about the transactional analytics for the data that is logged by the
variable tagged in a task. The information provided can be about the total sales in a month, invoicing and
payment trends, insight about new customers, or quote to order ratio.
When you tag variables for analytics in a task, and run the task, Bot Insight generates the analytics
dashboard . By default, the generated dashboard has the same name as that of the task. You can
customize the system generated dashboards based on your requirement.

Configuring a task for business analytics
To configure a business analytics automation task, enable analytics (using the Analyze: Open and
Analyze: Close actions) and tag the variables that are of interest for data analysis.
To configure a task for business analytics in an existing бот:
1. Войдите в Control Room.

Прим.:  Ensure that you have the Bot Creator license assigned to you.

2. In the Automation pane, select the folder that contains the task for which you want to enable
analytics.
The Actions palette appears in the left-hand side. См. раздел Действия palette for бот creation.

3. Build a bot.
For more information about building and editing a bot, see Get started building боты.

4. Insert the Analyze: Open action at the beginning of the transaction.
5. Insert the Analyze: Close action at the end of the transaction.

The Analyze: Close menu lists all the variables in the transaction. Select the variables that are
tagged in the transaction to process business analytics.

Прим.:  This feature enables you to deselect variables that might raise potential privacy concerns,
such as social security numbers or bank account details.

6. Щелкните Применить.
Click Reset to reset the variable selection.

7. Щелкните Сохранить.
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8. Click Run.
The Bot Run Successfully message appears.

9. Click Analyze.
The Bot Insight window appears.

10. Select a бот from the Select a Dashboard drop-down list.
Click the arrow to view the list of боты.

Using widgets
The Bot Insight dashboard provides a host of highly customizable widgets that you can use to gain insights
for specific scenarios.
When you select a particular бот, the default widgets automatically appear in the Dashboard window.
You can select the widgets and reposition them in the dashboard. To search for specific information, use
the Smart Filter function. You can enter the search parameters in the Smart Filter field.
You can also use multiple filters to search for data the widgets should display. Enter the filters, search
parameters, separated by a comma in the Smart Filter field. You can create, move, rename, and edit the
widget properties in a dashboard, based on your requirements.
The available options are:
• Chart filters
• Chart style
• Metric-based filters
• Comparison metrics
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You can group information by dates and use the Date Interval to view when a particular бот was active.
The following Date type options are available:
• Hour
• Day
• Week
• Month

Adding a dashboard widget
You can add custom widgets to the Bot Insight dashboard based on your requirements.
1. Open the dashboard.
2.

Click the  icon.
The Add Visualization window appears.

3. Select a widget that you want to add in the dashboard. См. раздел Bot Insight visualizations.
The Selected Chart window appears.

4. Необязательно. Click the Switch Widget button to change widgets.
5. Щелкните Вперед.

The Construct Your Query window appears.
6. Enter the query information to construct your dashboard. For reference to create a widget query, see

Configuring a Line Bar Chart query.
7. Щелкните Вперед.

The Ready to build window appears.
8. Щелкните Подтвердить.

The widget appears in the dashboard.
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Bot Insight visualizations
The Bot Insight dashboards provide customizable widgets that you can use to gain insights for specific
scenarios.
Bot Insight offers the following visualization widgets:
• Gauge Chart
• KPI
• Vertical Bar Chart
• Line Bar Chart
• Clustered Line Bar Chart
• Horizontal Bar Chart
• Vertical Stacked Bar Chart
• Horizontal Stacked Bar Chart
• Vertical Clustered Bar Chart
• Horizontal Clustered Bar Chart
• Heat Map
• Pie Chart
• Donut Chart
• Line Chart
• Scatter Chart
• Bubble Chart
• Datatable Chart
• World Map
• US Map

The Pie Chart widget enables you to visualize data in a circular statistical graphics that is divided into
slices.

Прим.:  Due to a limitation within the third-party recharts library, the data labels in a pie chart are
overlapping if it contains many slices. As a result, the labels in a pie chart are not clear and are shown only
when you hover over the slices.

The Heat Map widget enables you to visualize data as a heat map chart. You can specify the dates
by function (day, week, month, or year) to drill down to specific information. This map displays all the
possible available combinations of variable values in the X and Y axes. Blank heat map blocks appear if
there the value attached to the variable is 0. The color of the heat map block depends on the value of
the information displayed. A new window with all the relevant information appears when you hover your
mouse over a particular heat map block.
The Datatable Chart widget enables you to view and analyze information about all the logged data in
a tabular chart. You can select the attributes and metrics based on your requirement. All the available
attributes and metrics are selected by default.
The World Map widget provides information about the data variables and enables you to drill down to
specific information:
1. Country
2. State
3. Zip Code
4. Latitude
5. Longitude
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The US Map widget provides the following information about the data variables and enables you to drill
down to specific information:
1. Country
2. State
3. City
4. Zip Code

The Line Bar Chart and the Clustered Line Bar Chart widgets enable you to view and analyze
information about your metrics and attributes. You can input two metrics and one attribute in Line Bar
Chart widget, while in the Clustered Line Bar Chart widget, a Sub group option enables you to add
one more attributes if necessary.
The widget displays a line bar graph aggregated by group values when only one attribute is selected or a
clustered line bar graph aggregated by subgroup values when two attributes are selected. It displays group
sectioning which forms multi-axes labels . You can use Date types as interval options, grouped by Day,
Week, Month, Quarter, and Year, with the Day set as default.
Configuring a Line Bar Chart query

Задачи, связанные с данной
Adding a dashboard widget
You can add custom widgets to the Bot Insight dashboard based on your requirements.

Configuring a Line Bar Chart query
You can construct a custom query based on specific parameters to apply to your widget for line bar and
clustered line bar charts.
After you are in the Construct Your Query window, follow these steps to select parameters to apply to
your widget:
• Construct your query settings.

The query settings vary from widget to widget, but the selection process remains the same.
a) Enter the title of your widget in the Chart Title field.
b) Select a metric option in the Metric or Select Metrics field.

For Line Bar Chart and Clustered Line Bar Chart, the Metric field is renamed to Y1 Axis and
Y2 Axis.

c) Select an aggregated value in the Aggregated By field.
For Line Bar Chart and Clustered Line Bar Chart, the Aggregated By field is renamed to Y1
Aggregated By and Y2 Aggregated By with the same options.

d) Select a value from the Group By or Group 1 field.
e) Select a secondary value from the Sub Group By or Group 2 field.

Прим.:  The Sub Group By or Group 2 field is not available in the Line Bar Chart. For the
Metric, Group By and Sub Group By fields, the first value is shown as the default value.

f) Select a date value in the Date Interval field.

Прим.:  This field appears when you select the Date Type variable in the Group By and Sub
Group By fields.
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• Construct your advanced query settings.
You can enable more options to any widgets that support advanced settings.
a) Click Advanced Settings.

The settings display the default values. You can change the value of the fields if required.
b) Select a limit value in the Limit or Group Limit field.
c) Select a sort value in the Sort By or Group Sort By field.
d) Select a sort order value in the Sort Order or Group Sort Order field.
e) Select a secondary limit value in the Sub Group Limit or Group 2 Limit field.
f) Select a secondary sort value in the Sub Group Sort By or Group 2 Sort By field.
g) Select a secondary sort order value in the Sub Group Sort Order or Group 2 Sort Order field.

Прим.:  The Sub Group Limit, Sub Group Sort By and Sub Group Sort Order fields are not
available in the Line Bar Chart.

Editing a dashboard widget
You can edit the dashboard widget properties based on your requirements.
You can resize and save the widgets in the Bot Insight dashboard based on your requirements. When you
resize a dashboard widget, other widgets in the dashboard are automatically adjusted to fill in the available
layout.

Прим.:  Bot Insight allows you to resize widgets in the standard and the customized dashboards.
However, it does not allow you to save the widgets after resizing in the standard dashboard.

1. Open the dashboard widget.
2. Click the Edit button.

The Edit window appears.
The Edit menu offers the following options:

Название диаграммы Renames the chart
Измерение Changes the units
Агрегировать по Displays the run time (such as minimum,

maximum, average, and summation) of each бот
Группировать по Changes the parameters based on which the

widgets are grouped together
3. Click the bottom of a widget to change the attribute of the chart displayed within the widget.
4. Click Save As to save the widget.

Drilling down information in dashboard widget
You can drill down information from a dashboard widget based on your requirement. Select the options
available in the drop-down list to view specific information in the dashboard widgets.
To use the drill down function feature in the Bot Insight dashboard widget, do the following:
1. Open the dashboard and select the widget.
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2. Right-click to view the Drill Down menu.
Drill Down menu sample for a mortgage analytics processing bot :
• Gender
• Mortage Type
• Customer ID
• Company Name
• Email
• Loan Due Date
• Loan Origin Date

Прим.:  Bot Insight dynamically generates the Drill Down menu options based on the variables you
tag when creating the bot.

Renaming a dashboard widget
You can rename a dashboard widget based on your requirement. The default name of a dashboard widget
is based on the type of information that the widget displays.
To rename a widget in the Bot Insight dashboard, do the following:
1. Open the dashboard for the widget to edit.
2. Rollover and click the Edit button.

The Edit Chart window appears.
3. In the Chart Title field, enter the name of the widget.
4. Щелкните Вперед.

The Ready to build! Click Finish window appears.
5. Click Finish.

The Widget Updated message appears.

Exporting data from a dashboard widget
You can export data from the Bot Insight Custom Business dashboard widgets to CSV files based on the
requirement.
1. Open the dashboard.
2. Identify the widget.
3. Click the Actions icon.
4. Click Export.

The CSV file is automatically saved in your local drive as Chart name_summary_dd_mm_yyyy.

Data connector for Power BI
The data connector for Power BI enables you to establish a secure connection to Power BI, and generate
and visualize data analytics. You can connect to the Bot Insight APIs in Power BI and apply specific
parameters for each of the APIs.
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The connector transforms the Bot Insight API responses to data visualizations in Power BI. The data
connector for Power BI enables you to perform the following functions in Power BI:
• Authenticate and connect to the Control Room.
• Connect to APIs.
• Generate API responses.
• Transform the API responses to create a data model.
• Create visuals, charts or graphs, to represent the data.
• Create reports.
• Share reports with other users on Power BI.

You can access the following APIs from Power BI:
• getaudittrialdata
• getbotrundata
• gettaskvariableprofile
• gettasklogdata

Прим.:  Automation Anywhere Power BI connector is certified and available as part of the Microsoft Power
BI Desktop August release. The connector is available in the Other section of the Get Data dialog box in
Power BI.

To update your Power BI to the latest certified release version and use the connector plug-in, manually
deploy the data connector in Power BI. This enables you to retrieve information from the Bot Insight API
for data analytics.

Неполадка:  When you attempt to refresh the data in a Microsoft Excel worksheet, an
authentication error can occur from multiple simultaneous attempts through open windows and
tabs. To avoid this error, perform the following steps:
1. В настольном приложении Power BI перейдите в раздел Файл > Параметры и

настройки > Параметры.
2. From the Current File section, select Data Load.

Прим.:  Не выбирайте Загрузка данных в разделе «Глобальный»!

3. Disable the check box for Enable parallel loading of tables.

Информация, связанная с данной
Microsoft Power BI

Deploy Power BI connector
Deploy the data connector in Power BI to retrieve information from the Bot Insight API to enable data
analytics.
The connector can now be accessed directly from the Power BI desktop application. Ensure you meet the
following prerequisites.
• You should be using Power BI desktop version 2.92.943.0 or above.
• You know your Automation Anywhere Control Room version.
• You have your Control Room credentials.
• You have your Control Room URL.
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The following steps describe how to deploy the connector.
1. From your Power BI desktop application, select Get data.
2. In the search field, type and select Automation Anywhere.
3. Щелкните Подключить.
4. From the Login dialog box, enter your Control Room version and URL.
5. Enter your Control Room credentials.
6. Щелкните Подключить.

Configure Power BI connector

Configure Power BI connector
Configure the data connector in Power BI to retrieve information from the Bot Insight API to enable data
analytics.
Ensure that you have the Bot Insight Admin, or AAE_Admin role assigned to you in the Control
Room.

:  A Bot Creator license is required to generate a default dashboard with tasklogdata for Power BI.

Прим.:  The Power BI Connector is supported with Database Authenticated Control Room and Active
Directory authentication.

1. Войдите в Power BI.
2. Click Get Data.

The list of all the Power BI certified connectors appears.
• For information about how to access non-certified custom connectors, see Connector extensibility in

Power BI.
• When you update the dataset of two or more datasets, you might observe the Authentication

500 Internal server error. For resolving this error, see Automation 360 | Authentication 500 Internal
server error while refreshing in power BI (A-People login required).

3. Select Automation Anywhere and click Connect.
4. In the Automation Anywhere - Login window, enter the following information:

a) In the Control Room Version drop-down menu, select the version of the Control Room.
b) In the Control Room Host field, enter the IP address or the host name of the Control Room

server.
c) In the Bot Insight Host field, enter the IP address or host name of the Bot Insight server.

5. Щелкните OK.
6. In the Automation Anywhere Login window, enter your Bot Insight user name and password.

To provide the credentials for Active Directory authentication, you must enter the domain name
delimited by a double backslash (\\) along with the user name in the User name field. For example:
domain name\\user name.

7. Щелкните Подключить.
The Bot Insight APIs are authenticated and the authorization tokens are generated. The Bot Insight
APIs are loaded dynamically from Swagger, along with the applicable request parameters.

8. Select the required Bot Insight API from the Navigator menu and enter the information in the
respective fields.

© 2023 Automation Anywhere. All rights reserved.     2997

https://docs.microsoft.com/en-us/power-bi/connect-data/desktop-connector-extensibility
https://docs.microsoft.com/en-us/power-bi/connect-data/desktop-connector-extensibility
https://apeople.automationanywhere.com/s/article/Power-BI-Refresh-Issue
https://apeople.automationanywhere.com/s/article/Power-BI-Refresh-Issue


    Automation Anywhere - Оптимизация

9. Click Load.
The API retrieves specific information from the server.
To learn how to retrieve information from Bot Insight APIs in Power BI, see Bot Insight API.

10. Click Transform Data to convert the structured JSON response to a visual data model.

Информация, связанная с данной
Transform, shape, and model data in Power BI
Create reports and dashboards in Power BI
Collaborate, share, and integrate across products with Power BI

Пример. Retrieve information in Power BI using business
information API
The Power BI connector enables you to access the Bot Insight API from Power BI. This example task
shows you how to retrieve information from the Bot Insight API and build data visualizations in Power BI.
1. Open Power BI.
2. Open the Navigator window, and log in to the Control Room by entering the credentials.
3. In the Display Options menu, select fx Business Information.

The API window appears.
4. In the botName field, enter the name of the бот, or the task for which you want to visualize the

analytical data.
To enter multiple бот names, separate each name with a comma.
For example, SalesAPAC,SalesEMEA,SalesUS.

5. In the pageNo field, enter the offset value for the rows or records that you want to retrieve.
• If page = 0, and limit =1000, then rows 0 -1000 will be retrieved.
• If page = 1, and limit =1000, then rows 1001 -2000 will be retrieved.

6. Необязательно: In the fromDate field, enter the date from when you want to retrieve the
information.
Format: yyyy-mm-dd, or yyyy-mm-ddTh:m:s.msz (2020-02-20T12:45:23.000z)

Прим.:  If you do not enter a date, the API will return all available data.

7. Необязательно: In the toDate field, enter the date till when you want to retrieve the information.
Format: yyyy-mm-dd, or yyyy-mm-ddTh:m:s.msz (2020-03-21T15:45:32.000z)

Прим.:  If you do not enter a date, the API defaults to the current date.

8. In the limit field, enter the number of rows or records you want to retrieve.
9. Click Apply and then click Transform Data to convert the structured JSON response to a visual data

model.
10. Click Record and then click each list item until you drill down to the last element in business

information.
Power BI displays the data visualization.
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Configure Tableau web data connector in Bot Insight
The web data connector in Tableau enables you to establish a secure connection with Automation 360 and
to extract, visualize, and analyze data from Bot Insight.
• Ensure that your user name is registered in the Control Room and that you have Bot Insight Admin

or the AAE_Admin role assigned to you.
• Ensure you have access to the desktop or public version of Tableau software.

Прим.:  Single sign-on is not currently supported for Bot Insight. Connectors only work with the following
authentication mechanisms.
• Control Room database based authentication
• Active directory based authentication

The Web data connector in Tableau enables you to perform the following functions in Tableau:
• Authenticate and connect to the Control Room.
• Connect to Bot Insight APIs for business and operational information.
• Use business and operational information to create a data model.
• Create charts or graphs to represent the data.
• Create reports and share them with other users on Tableau.

1. Open Tableau.
2. Select Web Data connector from the Connect option in Data tab.
3. In the Web Data Connector window, enter your Automation Anywhere URL in web data connector

field: <control room url>/tableau/Login.html
4. In the Automation Anywhere - Login window, enter the following information:

a) In the Control Room Version drop-down menu, select the version of the Control Room.
b) In the Control Room URL field, enter the URL or the host name of the Control Room.
c) In User Name and Password field, enter your Bot Insight user name and password.

5. Click Submit to connect to Bot Insight APIs.
6. Select either Business Information or Operational Information in the Bot Insight window.

If you are an AAE_Admin, you can choose between Audit APIs and Operations APIs.
7. Click Get Data.

Bot Insight API retrieves information from the server.
8. Click Update Now to gather all the data from Bot Insight in Tableau.

You can use the retrieved data from Bot Insight for data visualizations and analysis in Tableau.
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Ссылки на API
The Automation 360 platform provides a comprehensive suite of API capabilities that enable customers,
partners, and community developers to automate end-to-end processes using API.
Automation Anywhere APIs are Representational State Transfer (RESTful) APIs. You can use these
REST APIs allow you to manage, administer, and run automations programmatically from your own
application. By incorporating Automation Anywhere APIs into various software programs, you can simplify
application integration across different platforms and reduce development effort. By using the Automation
Anywhere APIs you can reduce development effort, as you can implement the APIs on different platforms.
Automation Anywhere APIs provide a secure communication gateway to interact and exchange data. You
can use the Automation Anywhere APIs to:
• Register your device using the Bot Agent API.
• Perform various functionalities in the Control Room using the Control Room APIs.

API-интерфейсы Control Room
The Automation Anywhere Control Room provides APIs that enable you to customize how you (and your
automations) interact with Automation Anywhere.
You use Control Room APIs to:
• Manage bot deployments
• Create and manage credentials in the Credential Vault
• Create and manage user accounts and roles
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• Create and manage queues

Getting started with Control Room APIs

All requests must include an X-Authorization header with the JSON authentication token, or an
Authorization header with a Bearer token for requests to the Control Room. The following sections
provide details about the Control Room APIs available endpoints, methods, resources, authentication
protocols, parameters, and headers, as well as examples of common requests and responses.

Note:  The Bearer token is supported as of the Automation 360 v.27 release and later. It is unsupported
and ignored in any previous releases. You must obtain the Bearer token from our OAuth services. To
authorize your access, use either X-Authorization (using Authentication API) or Authorization (using
OAuth). You cannot use both in the same API.

The Control Room supports several API clients. To explore the Control Room APIs, download and install
Postman, then click https://www.postman.com/collections/bb5cd3541d29e192cd43 to download the Control
Room APIs collection. The following sections provide useful information about how to write a Control
RoomAPI request:
• Some APIs require you to filter, paginate, and sort the results to get the desired output. For more

information on filtering, pagination, and sorting, see Filtering, pagination, and sorting on page 3001.
• API response codes in the responses are described in the API response codes on page 3006.
• The Comparing Automation 360 and Enterprise 11 APIs on page 3007 compares the Enterprise 11 and

Automation 360 APIs.

To learn how to test Control Room APIs in Swagger and Postman, watch the following video:

Filtering, pagination, and sorting
The Control Room API supports filtering, pagination, and sorting for endpoints that return arrays of
resources.
The filtering mechanism filters the required resources, the sorting mechanism places the resources in
order; and the pagination mechanism then returns a specific range of those ordered resources. This topic
provides you the details to filter and sort the results of an API requests and also guides to handle the
pagination of large result sets returned from an API request.

Note:
• Sorting and filtering are supported for substrings. For example, if you want to search for боты or files

that have fin in their names, enter fin as the search criterion. All the боты and files that contain fin
in the names will be displayed, for example, Finance, Finder, DeltaFinance, and Dolfin.

• Wildcards are not supported for searching and filtering боты or files.

Filtering

Filtering allows you to apply Boolean condition against a collection of returned resources in order to subset
the collection to only those resources for which the condition is true. The most basic operation in an
Control Room API filters is to compare a field to a given value. It is possible to use equality comparison,
range comparison, or logical . Use the following operators to compare a field to a constant value.
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Операция Описание Пример

Equality comparison

eq Равно (=) UserEmailAddress, eq
first.last@aa.com

ne Not Equals UserEmailAddress, ne
first.last@aa.com

Range comparison

lt Меньше (<) Quantity lt 1500

le Меньше или равно Quantity le 1500

ge Больше или равно CreatedDateUtc ge 2021-03-15

gt Больше CreatedDateUtc gt 2021-03-15

Logical

и И Field1 eq 'abc' and Field2 eq
'def'

или Или Field1 eq 'abc' or Field2 eq 'def'

The filter query parameter allows you to apply basic, multiple, and convention oriented filters to
a request. The filters in the Control Room APIs are applied with single parameter or with multiple
parameters.
Single parameter filter
Single parameter filter allows the API request to select the responses by matching one or more members
of the response to the value passed in the query. The single parameter filter is represented in the following
image:

The JSON equivalent of the above image (single parameter filter) looks like:

{
  "filter": {
    "operator": "<NONE, lt, le, eq, ne, ge, gt, substring, and, or, not>",
    "field": "string",
    "value": "string"
  }
}
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For example, to list all the device pools that has a substring finance, use the following single parameter
filter:

POST http://{{ControlRoomURL}}/v2/devices/pools/list

{
   "filter":{
      "operator":"substring",
      "field":"name",
      "value":"finance"
   }
}

For more detailed sample on a single parameter filter, see Device Pools API.
Multiple parameter filter
Multiple parameter filter allows you to filter the results based on combining multiple conditions wrapped in
logical operands and and or.
• and: A binary operator that evaluates to true if all the conditions in the operands evaluate to true.
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• or: A binary operator that evaluates to true if atleast one of the conditions in the operands evaluate
to true.

The JSON equivalent of the above image (multiple parameter filter) looks like:

{
  "filter": {
    "operator": "<and, or>",
    "operands": [
      {
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        "operator": "<NONE, lt, le, eq, ne, ge, gt, substring, and, or,
 not>",
        "field": "string",
        "value": "string"
      },
      {
        "operator": "<NONE, lt, le, eq, ne, ge, gt, substring, and, or,
 not>",
        "field": "string",
        "value": "string"
      }
    ]
  }
}

For example, to list all the roles that has a substring Device, createdOn is after 2022-04-01, and
createdOn is before 2022-05-31, use the multiple parameter filtering with logical add operator as
follows:

POST http://{{ControlRoomURL}}//v1/usermanagement/roles/list

{
   "filter":{
      "operator":"and",
      "operands":[
         {
            "operator":"substring",
            "field":"name",
            "value":"Device"
         },
         {
            "operator":"gt",
            "field":"createdOn",
            "value":"2022-04-01T00:00:00.989Z"
         },
         {
            "operator":"lt",
            "field":"createdOn",
            "value":"2022-05-31T23:00:00.123Z"
         }
      ]
   }
   }

For more detailed sample on a single parameter filter, see User Management API.

Pagination

Pagination allows you to:
• Retrieve a limited collection of results.
• Offset a collection of results.

All Control Room APIs that returns a collection of records are paginated. API methods that support
pagination takes two (optional) parameters:
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Операция Описание

смещение The offset parameter controls the starting point within the collection of
response results. Default value is 0.

length The length parameter is the maximum number of records to retrieve
starting from the offset. Default value is 200.

The JSON snippet for pagination looks like:

"page":{ 
    "offset":5,
    "length":10
    }

For more detailed sample on a single parameter filter, see User Management API.

Sorting

Sorting allows you to order the results by any field, in ascending or descending order. For example, if you
are returning the roles, you can sort the roles by last modified date.

 "sort": [
    {
      "field": "string",
      "direction": "<asc, desc>"
    }

Direction
Type: Enum [ desc, asc ]
• asc = ascending (smallest to largest, 0 to 9, A to Z)
• desc = descending (largest to smallest, 9 to 0, Z to A)

For more detailed sample on a single parameter filter, see User Management API.

API response codes
Review the HTTP status codes of responses for Automation 360 APIs.

Status code HTTP name Описание

200 OK Успешно

201 Создан Success, for POST, PATCH or PUT requests.

202 Принято Indicates that the request has been accepted
for processing, but the processing has not
been completed.

204 No content Success, for DELETE requests and some
PATCH requests.

400 Bad request Request URL or request parameters are
incorrect.

© 2023 Automation Anywhere. All rights reserved.     3006

um-api-supported.html
um-api-supported.html


    Automation Anywhere - Ссылки на API

Status code HTTP name Описание

401 Требуется
аутентификация

Provide authentication details.

403 Unauthorized access The operation is not authorized.

404 Не найдено Control Room server did not find the requested
URL.

409 Конфликт The request could not be completed because
the code conflicts with the current state of the
resource, for example, a duplicate entry.

500 Internal server error Indicates that the server encountered a
problem. Clear the cookies and cache, and
then reload the page.

Comparing Automation 360 and Enterprise 11 APIs
Compare Automation 360 and Enterprise 11 APIs to understand the contract changes when you migrate
from Enterprise 11 to Automation 360.

API details Enterprise 11 Automation 360

Authentication API: Use this API to obtain the authentication token. The token is then used for
all subsequent API calls.

Method POST POST

Endpoint v1/authentication v1/authentication

Request body changes Не применимо No change

Response body changes Не применимо • Multi-factor authentication is
not supported

• Automation 360 response
returns the tenantUuID

Auto login credentials API: Use this API to set the Windows credentials for a Bot Runner. These
credentials are used for automatically login (auto-login).

Method POST PUT

Endpoint v1/credentialvault/
external/credentials/
loginsetting

v2/credentialvault/
loginsetting

Request body changes Не применимо Endpoint version change

Response body changes Не применимо Message displayed after
successfully updating the
credentials: Credentials
updated for <username>.
Enterprise 11 displays this
message: Credentials were
successfully updated.
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API details Enterprise 11 Automation 360

Automation management API: Use this API to create automations (schedule боты), and edit
and delete automations.

Method POST, PUT, and DELETE POST, PUT, GET, and DELETE

Endpoint v1/schedule v1/schedule

Request body changes Не применимо Minor change in request body to
pass бот input variables

Response body changes Не применимо Detailed response with бот
input variable details

User Management API: Use this API to create, edit, and delete users and roles.

Method POST, PUT, GET, and DELETE POST, PUT, GET, and DELETE

Endpoint v1/usermanagement v1/usermanagement

Request body changes Не применимо No change

Response body changes Не применимо No change

Migration API: Use this API to migrate боты from Enterprise 11 or Enterprise 10 to Automation
360

Method GET and POST GET and POST

Endpoint • v1/migration
• v2/migration

v2/migration

Response body changes Не применимо • Endpoint version change
• APIs used to connect to

the Enterprise 10 database
to migrate users, roles,
schedules, and боты

Request body changes Не применимо Because the endpoints and
request body are different, the
response body is also different.

Manual Dependency API: Use this API to add or remove a dependency (data files and such) to
or from a бот.

Method POST and DELETE Недоступно

Endpoint v1/files/
manualdependencies/

Недоступно

Request body changes Не применимо Недоступно

Response body changes Не применимо Недоступно

Repository Management API: Use this API to get боты and files from the Control Room
repository.

Method POST, DELETE, and GET POST, DELETE, and GET

Endpoint v1/repository v1/repository
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API details Enterprise 11 Automation 360

Request body changes Не применимо Additional APIs added to get
folder permissions

Response body changes Не применимо No change

File Dependency API: Use this API to get the file dependency metadata to run and schedule
боты.

Method GET Недоступно

Endpoint v1/files/
manualdependencies/

Недоступно

Request body changes Не применимо Недоступно

Response body changes Не применимо Недоступно

Бот Lifecycle Management (BLM) API: Use this API to move (export or import) боты and
dependent files across different Control Room environments.

Method POST POST

Endpoint v1/blm v2/blm

Request body changes Не применимо • Endpoint version change
• You cannot choose

dependencies when
exporting and importing

Response body changes Не применимо No change

Audit API: Use this API to get audit information about the product.

Method POST POST

Endpoint v1/audit v1/audit

Request body changes Не применимо No change

Response body changes Не применимо No change

Two-factor Authentication (2FA) API: Use this API to generate a 2FA token

Method GET and POST Недоступно

Endpoint v1/mfa Недоступно

Request body changes Не применимо Недоступно

Response body changes Не применимо Недоступно

Credential Vault API: Use this API to create, edit, and delete credentials and lockers.

Method POST, PUT, GET, and DELETE POST, PUT, GET, and DELETE

Endpoint v2/credentialvault v2/credentialvault

Request body changes Не применимо No change

Response body changes Не применимо No change

Бот Execution Orchestration API: Use this API to get the repository, automations, and devices
list.
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API details Enterprise 11 Automation 360

Method POST POST, PUT, GET, and DELETE

Endpoint v2/automations/deploy v3/automations/deploy

Request body changes Не применимо Бот deployment includes run-as
users

Response body changes Не применимо Returns deploymentID.
Enterprise 11 API response
returns automationID.

License API: Use this API to get product license information.

Method GET GET

Endpoint v2/license v2/license

Request body changes Не применимо No change

Response body changes Не применимо Additional APIs added to
update with license server and
additional details

Workload Management (WLM) API: Use this API to create, edit, and delete workload queues,
templates, and work items.

Method POST, PUT, GET, and DELETE POST, PUT, GET, and DELETE

Endpoint v2/wlm v3/wlm

Request body changes Не применимо No change

Response body changes Не применимо More APIs to manage WLM
entities

Bot Insight API: Use this API to get Bot Insight data for an automation.

Method POST, GET, and DELETE POST, GET, and DELETE

Endpoint v2/botinsight/data/api v2/botinsight/data/api

Request body changes Не применимо No change

Response body changes Не применимо No change

Bot Insight JSON API: Use to get business insights for an automation.

Method GET Не применимо

Endpoint v2/botinsight/data/api Не применимо

Request body changes Не применимо Не применимо

Response body changes Не применимо Merged with Bot Insight API

Related concepts
API-интерфейсы Control Room on page 3000
The Automation Anywhere Control Room provides APIs that enable you to customize how you (and your
automations) interact with Automation Anywhere.
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Configure the Control Room
Before you start creating workflows for бот deployment and workload management using Control Room
APIs, ensure you complete specific prerequisites and steps in the Control Room.
Ensure you have following licenses and permissions:
• One or more Bot Creator and unattended Bot Runner licenses.
• Control Room admin credentials to view, create, and configure users, roles, and device pools.
• The Create device pools feature permission or the AAE_Pool Admin role must be assigned to you.

Follow these steps to configure your Control Room with users, roles, and боты.
1. Log in to the Control Room as an admin.
2. Create a Control Room user.

Ensure that the user is assigned the AAE_BASIC role.
Create a user on page 2699

3. Create a custom role to map the users you created to Bot Runner and Bot folders.
a) In the Features tab, ensure you select these permissions: View my Scheduled Bots,

Schedule my bots to run, Run my Bots, View my Bots, and Generate my API Key.
b) In the Automation tab, expand the Bots folder and select the root folder or subfolders you want

to provide access for use. Ensure you select these permissions: Run and schedule and View
content.

c) In the Run as tab, select one or more Bot Runner from the list of Available bot runners.
d) In the Users tab, select the new user created in Step 1 to assign the custom role to this new

user.

4. Create a new device pool.
In the Consumers tab, ensure you select the custom role you created in Step 3.
Create device pools on page 2651

5. Log in to the Control Room as a Bot Creator and create боты to automate routine business tasks.
Build a Go be Great бот on page 2064
Ensure you check in the боты in the Bot folder or folders selected when creating the custom role
(Step 3). Check in a бот on page 2010

Roles and permissions
Assign roles from the Automation 360 Administration user interface or through the User Management API
to enable users to access features. You can assign a system-created role or create a custom role with
specific permissions.
Roles are a logical container for permissions and have interdependencies with боты, users, and licenses.
Users with the AAE_Admin role can create custom roles and assign roles to users.
Related concepts
Анализ кода on page 2798
Анализ кода позволяет оценить программу без выполнения кода. In Automation 360, the code analysis
feature analyzes the code and displays a list of violations based on a set rules. Вы можете просмотреть и
исправить любые ошибки кода или стилистические ошибки для вашей автоматизации.
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Related reference
Разрешения на использование для функции on page 2709
Пользователь с функцией AAE_Admin или пользовательской функцией с разрешением
Управление функциями может создавать и назначать функции пользователям для
предоставления им доступа к функциям и операциям.

Функции, созданные системой
Automation 360 включает в себя предопределенные функции, которые нельзя редактировать или
удалять. Each role has the standard permissions, plus the permissions necessary to perform the tasks
within the scope of that role.

Стандартные разрешения

Все созданные системой функции имеют разрешения, позволяющие выполнять указанные ниже
действия.
• Просмотреть информационные панели
• Просмотреть мои выполняемые действия
• Управлять моими учетными данными и ячейками
• Создать стандартных атрибуты для учетных данных (за исключением функций Discovery Bot)
• Просмотреть и управлять моими Bot Runner, Bot Creator и устройствами
• Просмотреть и управлять моими очередями
• Просмотреть основную информацию о пользователях и функциях

Разрешения на администрирование
Enable users to create and manage users and roles, to manage and update migrations, and to install
Control Room licenses.
You will be able to use the Retrieve role by ID. See User Management API endpoint with the role ID to
retrieve the permissions assigned to any system or user defined roles.

Users and roles permissions

Действие Тип ресурса Описание

usermanagement usermanagement Allows you to only view all other users in the
system. You cannot create, edit, or delete users.

Note:  Это разрешение необходимо назначить
перед назначением разрешений createuser
updateuser или deleteuser.

deleteuser usermanagement Allows you to delete other users the Control Room.

createuser usermanagement Allows you to create new users in the Control
Room.

updateuser usermanagement Allows you to edit all users in the system.
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Действие Тип ресурса Описание

rolesview rolesmanagement Пользователи с этим разрешением могут
просматривать функции в Control Room.

Note:  Это разрешение необходимо
назначить перед назначением разрешения
rolesmanagement.

rolesmanagement rolesmanagement Allows you to view and manage all roles in the
Control Room.

viewuserrolebasicinfousermanagement Allows you to view basic information on users and
roles.

Migration permissions

Действие Тип ресурса Описание

view миграция Allows you to view new migrations, but not run
them

Note:  Это разрешение необходимо назначить
перед назначением разрешения на manage
миграцией

manage миграция Allows you to view and run new migrations

updatestatus миграция Allows Bot Runner Run-as user to update the бот
conversion status in the Control Room

Licenses permissions

Действие Тип ресурса Описание

licensemanagementlicensemanagement Allows you to view the license details for the
Control Room.

licenseinstall licensemanagement Allows you to install Automation 360 licenses for the
Control Room.

licenseuserallocationlicensemanagement Allows you to assign device licenses to other users.

Note:  Only a user with the AAE_Admin role has the ability to view and manage settings in the Control
Room. См. раздел Функции, созданные системой on page 3012.
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Runtime Client Management permissions

Действие Тип ресурса Описание

runtimeclientsmanagementruntimeclientsmanagement Allows you to use the device mentioned in the
resourceId for deployment. This permission is
assigned when you are assigned a default device.

accessresourceany runtimeclientsmanagement Allows you to use any device for deployment. This
permission is currently granted for all users with
AAE_ADMIN role.

Global Values Permissions

Действие Тип ресурса Описание

manageuserscopevaluesglobalvalues Manage tenant level global values, given to
AAE_Admin only. This cannot be given to any
custom role at the moment.

managetenantscopevaluesglobalvalues Not used, created for future purpose.

other permissions

Действие Тип ресурса Описание

systemadmin system This permission is given to AAE_Admin only.
It is a system call and cannot be called manually.
This permission is used to count the number of
pages consumed against the entitled pages for the
IQ bot application.
It fetches a list of all the users with basic details
and license information.

view settings View settings.

Note:  You will be allowed to view settings only
with the system-created Admin role to view
Settings.

все botrunners Allows you to use any runAsUser for deployment.
This permission is currently granted for all users
with AAE_ADMIN role.

operationroom operationroom Legacy, not used and will be removed from the
future releases.

manage mfa Legacy, not used and will be removed from the
future releases.

1 Not available in the UI and is seen only in the API response.
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API permissions
Enables access to Bot Insight APIs and the ability to generate an API key.

Действие Тип ресурса Описание

botinsightapi api Предоставляет API-интерфейсам Bot Insight
RESTful доступ к данным, зарегистрированным в
Control Room и в рамках задачи во время запуска
«Производства».

generateapikey api Generate an apiKey that can be used in the
Authentication API.

Note:  Without the generateapikey permission,
use APIs by authenticating using their username and
password.

coeadmin botinsightapi Reserved. Not used for now and will be used when COE
dashboard is available in A360. Allows you to access the
COE dashboard when it is made available in A360.

accessreportingapi iqbotapi Allows you to access reporting details via an API.

accessuploadanddownloadapiiqbotapi Allows you to upload a document and download the
digitized result via an API.

accessnlpapi iqbotapi Allows you to access natural language processing
capabilities of the IQ Bot portal via an API.

Audit log permissions
View logs and details to record user activities. Enable users to view logs from the Control Room.

Действие Тип ресурса Описание

recentactivities recentactivities Allows you to view all audit log activity for the Control
Room

archiveaudit recentactivities Allows you to archive all audit log activity for the Control
Room

Automation Anywhere Robotic Interface (AARI) permissions
Assign AARI permissions to a custom role.

Действие Тип ресурса Описание

aaricrossteamreadaari Просмотр всех групп и просмотр участников группы

aaricrossprocessreadaari Просмотр всех процессов и просмотр участников группы и
менеджеров
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Действие Тип ресурса Описание

aariteammanagementaari Создание и просмотр групп, редактирование имен групп,
описаний и тегов процессов. Добавление новых групп,
участников групп и назначенных процессов

aaritaskmanagementaari Отправка и просмотр задач из процессов, назначенных
группе

aaricasemanagementaari Создание и просмотр запросов из процессов, назначенных
группе

aariglobalcasemanagementaari Просмотр запросов и задач процесса.

Note:  This permission does not grant the ability to create a
request or submit a task

aariglobalprocessmanagementaari Просмотр зарегистрированных общих процессов и
назначенных менеджеров и групп, редактирование тегов
процессов и назначение менеджеров и групп

Note:  This permission does not grant the ability to create a
process.

aariglobalteammanagementaari Просмотр групп и назначенных пользователей,
редактирование названий и описаний групп. Add new
processes, managers and users to a team

Note:  This permission does not grant the ability to create a
team.

aarischeduler aari Allows users to be used as AARI scheduler

Бот and bot credential permissions
Enables users to access features for managing боты and the credentials used by боты.

Разрешения Боты

Действие Тип ресурса Описание

view repositorymanager Allows you to view the боты they created and боты that
were assigned to them.

Note:  Это разрешение необходимо назначить перед
назначением любых других разрешений для боты.

запустить repositorymanager Allows you to run the боты they created and боты that
were assigned to them.

экспорт repositorymanager Allows you to export боты and related бот dependencies
for which they have download permission.
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Действие Тип ресурса Описание

импортировать… repositorymanager Allows you to import боты and бот dependencies for
which they have upload permission.

createfolders repositorymanager Разрешает пользователям создавать папки в папках,
к которым у них есть доступ.

renamefolders repositorymanager Allows you to rename the folders they have access to.

Note:  Переименовать можно только пустые папки.

cancelcheckout repositorymanager Allows you to cancel бот checkout and unlock the file
from the public repository.

forceunlock repositorymanager Allows you to unlock locked боты.

accessresourceany repositorymanager Allows you to get permissions to the resources.
Например:
runtimeclientsmanagement, pool, queue and so on.

setproductionversion repositorymanager Allows you to set the production version of боты.

все repositorymanager Allows you to get all the repository permissions.

gitrestore repositorymanager Allows you to get git restore permissions.

Credentials and ячейки permissions

Действие Тип ресурса Описание

managecredentials учетные данные Allows you to create, edit, and delete their own
credentials. Кроме того, пользователь может
взаимодействовать с учетными данными из
назначенных ему ячейки.

Note:  У всех функций есть это разрешение по
умолчанию.

создать ячейка Allows you to create and manage their own ячейки.

consume ячейка Allows you to consume a locker ячейка

createstandard credentialattribute Allows you to create a standard attribute for a credential
that is shared across all users of that credential .

updateany credentialattributevalueAllows you to view and edit their own masked attributes.

botautologinapi credentialattributevalueAllows you to automate the login process to run боты
remotely.

addcredential credentialmanager

updatecredential credentialmanager

deletecredential credentialmanager

Legacy, not used and will be removed from the future
releases.
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Note:  Пользователь с функцией AAE_Locker Admin может просматривать все учетные данные и
ячейки в Control Room. См. раздел Функции, созданные системой on page 3012.

Разрешения Bot Store
Enables users to view and manage Bot Store packages.

Действие Тип ресурса Описание

view botstore Allows you to view Bot Store.

addfrom botstore Allows you to add бот пакеты from Bot Store to their
Control Room private workspace.

отправить botstore Allows you to submit бот пакеты to Bot Store.

Dashboard and activity permissions
Enables all users to view dashboards. Activity permissions enable users to view, manage, and schedule бот
activities.

Dashboard and Activity Permissions

Действие Тип ресурса Описание

view dashboard View dashboard.

Note:  У всех функций есть это разрешение по умолчанию.

myschedule taskscheduling All users can view their own activity.

Note:  У всех функций есть это разрешение по умолчанию.

managemyscheduletaskscheduling All users can pause, resume, or cancel their own activity and
move their finished activities to history.

manageeveryonescheduletaskscheduling A user can monitor ongoing automations where a user has
either run or schedule access on the respective бот. The user
can monitor and manage ongoing automations.

view taskscheduling Users can see their scheduled боты regardless of which user
scheduled the бот.

addschedule taskscheduling It requires permission to view and manage Bot Runner.

updateschedule taskscheduling Users can edit their scheduled боты, even if the боты are
scheduled by a different user.

deleteschedule taskscheduling Users can delete schedules for any of their боты regardless of
which users scheduled the бот.
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Действие Тип ресурса Описание

manageallmyfolderschedulestaskscheduling Users can view, edit, and delete all the schedules on the
бот folders that the user has access to. Сюда относятся
расписания, созданные пользователем, а также созданные
другими пользователями.

manageallschedulestaskscheduling Users can view, edit, and delete all the schedules in the system.
Сюда относятся расписания, созданные пользователем, а
также созданные другими пользователями.

setautomationprioritytaskscheduling Users can set the automation priority to high from the default
medium. Automations with high priority are deployed ahead of
automations with medium and low priority.

everyonescheduletaskscheduling Users can monitor those ongoing automations where the they
have either run or schedule access on the respective TaskBot.

Devices permissions
Enable you to register, view, and manage devices used to run боты.

Действие Тип ресурса Описание

register устройства Allows you to register a localhost device.

все устройства Allows you to view and manage all devices in the Control Room.

удалить устройства Allows you to delete devices that they registered.

редактировать устройства Allows you to edit the devices that they have permission to see.
Allows you to view and manage all (registered and non-
registered) devices from a specific accessible group.

Note:  To view and manage registered and non-registered
devices,
• The Control Room administrator must grant access to

manage a specific set of devices.
• You must select Devices from my device pool(s) to edit

devices from device pools and Run as user(s) default
device to edit Run as user(s) default device options in the
Edit devices permission.

view устройства Allows you to view and manage Bot Creator, Bot Runner, and
device pools.

Note:  У всех функций есть это разрешение по умолчанию.

attestcredentials устройства Allows you to deploy the бот during a session on the user's
device without system password.

создать pool Allows you to create and manage their own device pools.
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Note:  A user with the AAE_Pool Admin role is able to manage all device pools in the Control Room. См.
раздел Функции, созданные системой on page 3012.

Разрешения Discovery Bot
Enable users to view or manage Discovery Bot processes, recordings, aggregations, and opportunities.

Process permissions

Действие Тип ресурса Описание

viewprocess processdiscovery Разрешает пользователям просматривать
назначенные процессы.

Note:  Это стандартное разрешение. Это разрешение
необходимо назначить перед назначением любых
других разрешений на обнаружение процессов.

viewallprocess processdiscovery Разрешает пользователям просматривать все
определенные процессы.

editprocess processdiscovery Разрешает пользователям создавать и редактировать
процессы.

Recording permissions

Действие Тип ресурса Описание

viewrecording processdiscovery Разрешает пользователям просматривать
собственную запись.

Note:  Это разрешение необходимо назначить
перед назначением любого из перечисленных ниже
разрешений.

createrecording processdiscovery Allows users to run recorder and create recording.

editrecording processdiscovery Разрешает пользователям редактировать
собственную запись.

deleterecording processdiscovery Разрешает пользователям удалять собственную
запись.

viewallrecording processdiscovery Разрешает пользователям просматривать все записи.

editallrecording processdiscovery Allows users to edit all recordings.
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Aggregation permissions

Действие Тип ресурса Описание

viewmanualaggregationprocessdiscovery Разрешает пользователям просматривать
собственные агрегирования.

viewallaggregations processdiscovery Разрешает пользователям просматривать все
агрегирования.

createdeletemanualaggregationprocessdiscovery Разрешает пользователям создавать и удалять
агрегирования.

updatemanualaggregationprocessdiscovery Разрешает пользователям обновлять агрегирования.

viewsystemaggregationprocessdiscovery Разрешает пользователям просматривать системные
агрегирования.

Opportunity permissions

Действие Тип ресурса Описание

viewopportunity processdiscovery Allows users to view opportunities within an assigned
process.

Note:  You must assign this permission before assigning
any of the opportunity permissions.

editopportunity processdiscovery Allows users to edit opportunities within an assigned
process.

viewallopportunity processdiscovery Allows users to view all the opportunities.

createdeleteopportunityprocessdiscovery Разрешает пользователям создавать и удалять
возможности в пределах назначенного процесса.

converttobot processdiscovery Разрешает пользователям выполнять
преобразование возможности в бот.

exportopportunity processdiscovery Разрешает пользователям экспортировать
возможность.

Event triggers permissions
Enable users to run боты automatically depending on a specific event, such as a new window opening. You
can limit users ability to only view or to view and manage triggers.

Действие Resource type Описание

view eventtriggers Разрешает пользователям просматривать триггеры
событий.

manage eventtriggers Разрешает пользователям просматривать и
управлять триггерами событий.
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Действие Resource type Описание

managemytriggers eventtriggers Allows users to view and manage event triggers from
their private repository, on their local devices.

Additionally, you must enable the view пакеты permission as well:

Действие Resource type Описание

view packagemanager Allows users to view packages

Разрешения IQ Bot
Предоставьте пользователям возможность просматривать разрешения для IQ Bot, создавать
обучаемые экземпляры и управлять ими, импортировать и экспортировать домены, а также
управлять настройками конфигурации и миграцией IQ Bot.

Разрешения IQ Bot

Действие Тип ресурса Описание

viewiqbot iqbot Позволяет вам просматривать информационные
управления по умолчанию на портале IQ Bot.

Note:  Это разрешение необходимо назначить
перед назначением любого из перечисленных ниже
разрешений.

view iqbotpages Позволяет просматривать лицензированные
страницы iqbot

utilize iqbotpages Позволяет использовать лицензированные страницы
iqbot

Разрешения для обучаемых экземпляров

Действие Тип ресурса Описание

viewlearninginstance viewiqbot Позволяет вам просматривать ваши обучаемые
экземпляры на портале IQ Bot.

Note:  Это разрешение необходимо назначить
перед назначением любого другого разрешения для
обучаемого экземпляра.

viewlearninginstancefromsameroleviewlearninginstance Позволяет просматривать обучаемые экземпляры,
созданные другими пользователями с той же
функцией, на портале IQ Bot.

assignroletolearninginstancesviewlearninginstance Позволяет назначить некоторые пользовательские
функции обучаемому экземпляру.
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Действие Тип ресурса Описание

viewalllearninginstancesviewlearninginstance Позволяет просматривать все обучаемые экземпляры
на портале IQ Bot.

launchvalidatior viewlearninginstance Позволяет получать доступ к валидатору IQ
Bot для просмотра и обновления документов с
исключениями.

createlearninginstancesviewlearninginstance Позволяет создавать обучаемые экземпляры на
портале IQ Bot.

editlearninginstances viewlearninginstance Позволяет редактировать обучаемые экземпляры на
портале IQ Bot.

deletelearninginstancesviewlearninginstance Позволяет удалять свои обучаемые экземпляры на
портале IQ Bot.

sendlearninginstancestoprodviewlearninginstance Позволяет отправлять свои обучаемые экземпляры в
производство на портале IQ Bot.

trainlearninginstancegroupsviewlearninginstance Позволяет обучать свои группы обучаемых
экземпляров на портале IQ Bot.

Разрешения для доменов

Действие Тип ресурса Описание

viewdomain viewiqbot Позволяет просматривать все домены на портале IQ
Bot.

Note:  Это разрешение необходимо назначить перед
назначением любых других разрешений для доменов.

createdomains viewdomain Позволяет создавать домены на портале IQ Bot.

editdomains viewdomain Позволяет редактировать домены на портале IQ Bot.

importdomains viewdomain Позволяет импортировать домены на портале IQ Bot.

exportdomains viewdomain Позволяет экспортировать домены на портале IQ Bot.

deletedomains viewdomain Позволяет удалять домены на портале IQ Bot.

Разрешения на администрирование

Действие Тип ресурса Описание

viewadministration viewiqbot Позволяет получать доступ к вкладке
Администрирование на портале IQ Bot.

Note:  Это разрешение необходимо назначить
перед назначением любых других разрешений на
администрирование.
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Действие Тип ресурса Описание

viewandmanagesettingsviewadministration Позволяет управлять расширенными настройками
конфигурации портала IQ Bot.

viewandmanagemigrationviewadministration Позволяет получать доступ к утилите миграции
для импорта и экспорта обучаемых экземпляров на
портале IQ Bot.

MetaBot permission
MetaBots are obsolete in Automation 360. However, this permission is valid to ensure that all functionality
previously available is supported in Automation 360.

Access to MetaBot Designer Permission/feature ID is not available.
Bot Creator users can access MetaBot Designer to
view, create, and update MetaBots.

Note:  This feature is available for internal use only.

Пакет manager permissions
Enable users to view and manage пакеты.

Действие Тип ресурса Описание

view packagemanager Allows you to view пакеты.

manage packagemanager Allows you to view and manage пакеты.

Разрешения для рабочей нагрузки
Enable you to create and manage workitems, workitem models, queues, and automations in the Control
Room.

Действие Тип ресурса Описание

myschedule taskscheduling Allows you to view and manage their own schedules.

view очередь Allows you to view their own queues.

создать очередь Allows you to create and manage their own queues.

calculate sla Allows you to calculate workload Service Level
Agreements (SLA).

view workload Legacy, not used and will be removed from the future
releases.

accessresourceany очередь Legacy, not used and will be removed from the future
releases.
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Note:  A user with the AAE_Queue Admin role has all the above permissions. In addition, the
AAE_Queue Admin is able to manage all the queues in the Control Room. См. раздел Функции,
созданные системой on page 3012.

Bot Agent API: Auto registration
Automatically register and connect your device to a Control Room by using the Auto registration API.
This API uses the generic registration token from the auto-registration.properties file to
register the device in the specified Control Room URL. You cannot autoregister the device if the
Control Room URL is not available in the auto-registration.properties file. The auto-
registration.properties file must be available on your local system, and you must not delete the
file after the registration is complete.

Note:  To register the device from the command line or API, you must set the
AA_DELAY_REGISTRATION_UNTIL_LOGIN MSI parameter.

Запрос

POST http://127.0.0.1:22113/v1/registration/auto

Тело запроса:

{
    "url": "https://{controlroom url}",
    "userName": "dpcreator"
}

Request parameters

Параметр Тип Требуется Описание

url Строка Да Specify the Control Room URL to autoregister the
device.

userName Строка Нет Specify the Control Room user to associate the device
as the default device.

Ответ

{
  "result": "REGISTERED",
  "deviceId": "11",
  "crUrl": "control_room_url",
  "userName": "dpcreator"
  "installationType": "SYSTEM_WIDE",
  "crSwitchAllowed": "false",
}
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Response parameters

Параметр Тип Описание

result Строка Status of the device registration.

deviceId Число Unique ID of the device the Bot Agent is installed on.

crUrl Строка The Control Room URL where the device is autoregistered.

userName Строка The username for which the device is associated as default device.

installationType Строка The type of installation that is performed.

crSwitchAllowed Строка Indicates whether the device can be registered on a different Control Room.

The REST API responds to each request with an HTTP response code. For response codes, see API
response codes on page 3006.
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